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     [bookmark: pgfId-3426942]Introduction to the Cisco FireSIGHT System 
      
      
 
     
 
 
    [bookmark: pgfId-3558669]The Cisco FireSIGHT System is an integrated suite of network security and traffic management products, deployed either on purpose-built platforms or as a software solution.
 
    [bookmark: pgfId-3558671]The system is designed to help you handle network traffic in a way that complies with your organization’s security policy—your guidelines for protecting your network. A security policy may also include an acceptable use policy (AUP), which provides employees with guidelines of how they may use your organization’s systems.
 
    [bookmark: pgfId-3594299]In a typical deployment, multiple traffic-sensing managed devices installed on network segments monitor traffic for analysis and report to a managing Defense Center. Deployed inline, devices can affect the flow of traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-3594312]Tip There are several models of device and Defense Center. Managed devices include physical and virtual FirePOWER appliances, Cisco NGIPS for Blue Coat X-Series, and Cisco ASA with FirePOWER Services (ASA FirePOWER). Defense Centers can also be deployed as physical or virtual appliances. When necessary, appliance models are further grouped into series and family. System capabilities often depend on model and license.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3594417]The Defense Center provides a centralized management console with web interface that you can use to perform administrative, management, analysis, and reporting tasks. Physical managed devices also have a web interface that you can use to perform initial setup and basic analysis and configuration tasks. Virtual managed devices, Cisco NGIPS for Blue Coat X-Series, and ASA FirePOWER devices do not have a FireSIGHT System web interface. For these devices, you must use a CLI to perform any tasks that you cannot complete using the managing Defense Center.
 
    [bookmark: pgfId-3592894]This guide provides information about the features and functionality of the FireSIGHT System. The explanatory text, diagrams, and procedures in each chapter provide detailed information to help you navigate the user interface, maximize the performance of your system, and troubleshoot complications.
 
    [bookmark: pgfId-3379812]The topics that follow introduce you to the FireSIGHT System, describe its key components, and help you understand how to use this guide:
 
     
     	 [bookmark: pgfId-3380077]Introduction to the Defense Center
 
     	 [bookmark: pgfId-3586519]Introduction to Managed Devices
 
     	 [bookmark: pgfId-3586524]Defense Centers and Devices Delivered with Version 5.4.X
 
     	 [bookmark: pgfId-3255238]FireSIGHT System Components
 
     	 [bookmark: pgfId-1342989]Documentation Resources
 
     	 [bookmark: pgfId-2661634]Documentation Conventions
 
     	 [bookmark: pgfId-2934374]IP Address Conventions
 
    
 
   
 
    
     [bookmark: pgfId-3594610][bookmark: 70136]Introduction to Managed De[bookmark: marker-3594609]vices
 
    [bookmark: pgfId-3594611]Managed devices installed on network segments monitor traffic for analysis. Deployed passively, managed devices gather detailed information about your organization’s assets: hosts, operating systems, applications, users, transmitted files (including malware), vulnerabilities, and so on. The FireSIGHT System correlates this information for your analysis so you can monitor the websites your users visit and the applications they use, assess traffic patterns, and receive notifications of intrusions and other attacks.
 
    [bookmark: pgfId-3594612]Deployed inline, the system can affect the flow of traffic using access control, which allows you to specify, in a granular fashion, how to handle the traffic entering, exiting, and traversing your network. The data that you collect about your network traffic and all the information you glean from it can be used to filter and control that traffic based on:
 
     
     	 [bookmark: pgfId-3594613]simple, easily-determined transport and network layer characteristics: source and destination, port, protocol, and so on
 
     	 [bookmark: pgfId-3594614]the latest contextual information on the traffic, including characteristics such as reputation, risk, business relevance, application used, or URL visited
 
     	 [bookmark: pgfId-3594615]Microsoft Active Directory LDAP users in your organization; you can grant different levels of access to different users
 
     	 [bookmark: pgfId-3594616]characteristics of encrypted traffic; you can also decrypt this traffic for further analysis
 
     	 [bookmark: pgfId-3594617]whether unencrypted or decrypted traffic contains a prohibited file, detected malware, or intrusion event
 
    
 
    [bookmark: pgfId-3594618]Each type of traffic inspection and control occurs where it makes the most sense for maximum flexibility and performance. For example, reputation-based blacklisting, because it uses simple source and destination data, can block prohibited traffic early in the process, while detecting and blocking intrusions and exploits is a last-line defense.
 
    [bookmark: pgfId-3594622]In addition to access control, network management features on Series 3 devices allow them to serve in switched and routed environments, perform network address translation (NAT), and to build secure virtual private network (VPN) tunnels between virtual routers you configure. You can also configure bypass interfaces, aggregated interfaces, fast-path rules, and strict TCP enforcement. 
 
    [bookmark: pgfId-3594623]For more information, see:
 
     
     	 [bookmark: pgfId-3594627]Series 2 and Series 3 Managed Devices
 
     	 [bookmark: pgfId-3594635]64-Bit Virtual Managed Devices
 
     	 [bookmark: pgfId-3594639]Cisco NGIPS for Blue Coat X-Series
 
     	 [bookmark: pgfId-3594643]Cisco ASA with FirePOWER Services
 
     	 [bookmark: pgfId-3635165]Configurations that Restart the Snort Process
 
     	 [bookmark: pgfId-3635169]How Snort Restarts Affect Traffic
 
    
 
     
      [bookmark: pgfId-3635177][bookmark: 42458]Series 2 and Series 3 Managed Devices
 
     [bookmark: pgfId-3611612]Series 3 devices, which include all Cisco FirePOWER 7000 Series and 8000 Series devices, are the third series of physical devices purpose-built for the FireSIGHT System. Series 3 devices have a range of throughputs, but share most of the same capabilities. In general, 8000 Series devices are more powerful than 7000 Series; they also support additional features such as fast-path rules, link aggregation, and stacking.
 
     [bookmark: pgfId-3614665]Note that both Defense Centers and Series 3 devices are in the midst of a branding transition. The Defense Center is also referred to as the FireSIGHT Management Center, and Series 3 devices are also referred to as FirePOWER devices. Product identification numbers for Defense Centers may begin with FS rather than DC. Similarly, product identification numbers for Series 3 devices may begin with FP rather than 3D. The model numbers otherwise remain unchanged. For example, a DC4000 and an FS4000 refer to the same Defense Center.
 
     [bookmark: pgfId-3622511]Series 2 is the second series of physical managed devices. Series 2 devices automatically have most of the capabilities associated with a Protection license: intrusion detection and prevention, file control, and simple network-based access control.
 
     [bookmark: pgfId-3622518]However, because of resource and architecture limitations, Series 2 devices support a restricted set of features granted by the Protection license. Series 2 devices cannot perform Security Intelligence filtering or file control for nested files inside archive files. Also, Series 2 devices cannot perform geolocation-based access control, even with a FireSIGHT-licensed Defense Center. You cannot enable other licensed capabilities on a Series 2 device.
 
     [bookmark: pgfId-3594712]Although Cisco no longer ships new Series 2 appliances, you can update or reimage Series 2 devices running earlier versions of the system to Version 5.4.1. Note that reimaging results in the loss of almost all configuration and event data on the appliance. For more information, see the FireSIGHT System Installation Guide.
 
      
       
     
 
     
 
     [bookmark: pgfId-3594719]Tip You can migrate specific configuration and event data from a Version 4.10.3 deployment to a Version 5.2 deployment, which you can then update to Version 5.4.1. For more information, see the FireSIGHT System Migration Guide for Version 5.2.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3594727][bookmark: 16526]64-Bit Virtual Managed Devices
 
     [bookmark: pgfId-3601211]You can deploy 64-bit virtual devices as ESXi hosts using the VMware vSphere Hypervisor or vCloud Director environment. You can also enable VMware To[bookmark: marker-3601215]ols on all supported ESXi versions. For a list of supported versions, see the FireSIGHT System Virtual Installation Guide. For information on the full functionality of VMware Tools, see the VMware website (http://www.vmware.com/).
 
     [bookmark: pgfId-3601230]Virtual appliances use e1000 (1 Gbit/s) interfaces, or you can use the VMware vSphere Client to replace the default sensing and management interfaces with vmx[bookmark: marker-3601231]net3 (10 Gbit/s) interfaces. You can also use the VMware vSphere Client to create additional management interfaces on the virtual Defense Center. For more information, see the FireSIGHT System Virtual Installation Guide.
 
     [bookmark: pgfId-3601629]Regardless of the licenses installed and applied, virtual appliances do not support any of the system’s hardware-based features: redundancy and resource sharing, switching, routing, and so on. Also, virtual devices do not have a FireSIGHT System web interface.
 
    
 
     
      [bookmark: pgfId-3601204][bookmark: 11417]Cisco NGIPS for Blue Coat X-Series[bookmark: marker-3601203]
 
     [bookmark: pgfId-3594776]You c[bookmark: marker-3594764]an install [bookmark: marker-3594765]Cisco NGIPS for Blue Coat X-Series on a Blue Coat [bookmark: marker-3594772]X-Series platform. This software-based appliance functions similarly to a virtual managed device. Regardless of the licenses installed and applied, Cisco NGIPS for Blue Coat X-Series does not support any of the following FireSIGHT System features:
 
      
      	 [bookmark: pgfId-3611975]Cisco NGIPS for Blue Coat X-Series does not support features granted by the Malware or Control licenses, including advanced malware protection (AMP), application control, user control, and any of the system’s hardware-based features (clustering, stacking, switching, routing, VPN, NAT, and so on).
 
      	 [bookmark: pgfId-3617255]You cannot use Cisco NGIPS for Blue Coat X-Series to decrypt or inspect encrypted traffic (SSL inspection).
 
      	 [bookmark: pgfId-3611788]You cannot use Cisco NGIPS for Blue Coat X-Series to filter network traffic based on its country or continent of origin or destination (geolocation-based access control).
 
      	 [bookmark: pgfId-3611502]You cannot use the Defense Center web interface to configure Cisco NGIPS for Blue Coat X-Series interfaces.
 
      	 [bookmark: pgfId-3594800]You cannot use the Defense Center to shut down, restart, or otherwise manage Cisco NGIPS for Blue Coat X-Series processes.
 
      	 [bookmark: pgfId-3594807]You cannot use the Defense Center to create backups from or restore backups to Cisco NGIPS for Blue Coat X-Series.
 
      	 [bookmark: pgfId-3594812]You cannot apply health or system policies to Cisco NGIPS for Blue Coat X-Series. This includes managing time settings.
 
     
 
     [bookmark: pgfId-3594816]Cisco NGIPS for Blue Coat X-Series does not have a web interface. However, it has a command line interface (CLI) unique to the X-Series platform. You use this CLI to install the system and to perform other platform-specific administrative tasks, such as:
 
      
      	 [bookmark: pgfId-3594820]creating Virtual Appliance Processor (VAP) groups, which allow you to take advantage of the X-Series platform’s load balancing and redundancy benefits (comparable to Cisco physical device clustering)
 
      	 [bookmark: pgfId-3594827]configuring passive and inline sensing interfaces, including configuring the interface’s maximum transmission unit (MTU)
 
      	 [bookmark: pgfId-3594828]managing processes
 
      	 [bookmark: pgfId-3594829]managing time settings, including NTP settings
 
     
 
    
 
     
      [bookmark: pgfId-3594835][bookmark: 39901]Cisco ASA with FirePOWER Services [bookmark: marker-3594834]
 
     [bookmark: pgfId-3594844]Cisco ASA with FirePOWER Services (ASA FirePOWER devices) functions similarly to a managed device. In this deployment, the ASA device provides the first-line system policy and passes traffic to the FireSIGHT System for access control, intrusion detection and prevention, discovery, and advanced malware protection.
 
     [bookmark: pgfId-3594852]Regardless of the licenses installed and applied, ASA FirePOWER devices do not support any of the following FireSIGHT System features:
 
      
      	 [bookmark: pgfId-3594862]ASA FirePOWER devices do not support the FireSIGHT System’s hardware-based features: clustering, stacking, switching, routing, VPN, NAT, and so on. However, the ASA platform does provide these features, which you can configure using the ASA CLI and ASDM. See the ASA documentation for more information.
 
      	 [bookmark: pgfId-3612553]ASA FirePOWER devices do not support SSL inspection.
 
      	 [bookmark: pgfId-3594869]You cannot use the Defense Center web interface to configure ASA FirePOWER interfaces.
 
      	 [bookmark: pgfId-3594876]You cannot use the Defense Center to shut down, restart, or otherwise manage ASA FirePOWER processes.
 
      	 [bookmark: pgfId-3594883]You cannot use the Defense Center to create backups from or restore backups to ASA FirePOWER devices.
 
      	 [bookmark: pgfId-3594884]You cannot write access control rules to match traffic using VLAN tag conditions.
 
     
 
     [bookmark: pgfId-3619596]The ASA FirePOWER device does not have a FireSIGHT web interface. However, it has software and a command line interface (CLI) unique to the ASA platform. You use these ASA-specific tools to install the system and to perform other platform-specific administrative tasks. For more information, see the ASA FirePOWER module documentation.
 
     [bookmark: pgfId-3633357]You can manage ASA5506-X, ASA5506H-X, ASA5506W-X, ASA5508-X, ASA5516-X, and ISA 3000 devices as standalone devices or managed devices. You manage standalone ASA FirePOWER modules through ASA FirePOWER Configuration in ASDM and managed ASA FirePOWER modules with a Defense Center. You cannot manage an ASA FirePOWER module with ASDM when the device is registered to a Defense Center.
 
     [bookmark: pgfId-3594898]Note that if you edit an ASA FirePOWER device and switch from multiple context mode to single context mode (or visa versa), the device renames all of its interfaces. You must reconfigure all FireSIGHT System security zones, correlation rules, and related configurations to use the updated ASA FirePOWER interface names.
 
      
       
     
 
     
 
     [bookmark: pgfId-3594911]Note The Defense Center does not display ASA interfaces when the ASA FirePOWER device is deployed in SPAN port mode.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3623210]Cisco ISA 3000
 
     [bookmark: pgfId-3623257]The Cisco ISA 3000 is a DIN Rail mounted ruggedized industrial security appliance that provides firewall, threat defense, and VPN services. It is low-power, fan-less, with Gigabit Ethernet and a dedicated management port. There are two SKUs:
 
     [bookmark: pgfId-3623273]• Copper SKU with 4x10/100/1000Base-T with a management port
 
     [bookmark: pgfId-3623281]• Fiber SKU with 2x1GbE SFP and 2x10/100/1000Base-T with a management port.
 
     [bookmark: pgfId-3623289]The Cisco ISA 3000 comes with Cisco ASA firewall protection, combined with industry-leading threat and advanced malware protection.The Cisco ISA 3000 runs Cisco ASA with FirePOWER Services. For more information, see Cisco ASA with FirePOWER Services.
 
    
 
     
      [bookmark: pgfId-3594913][bookmark: 87523]Summary of Supported Capabilities by Managed Device Model
 
     [bookmark: pgfId-3609353]When running Version 5.4.1, FireSIGHT System devices have varying throughputs and capabilities, which depend on model and license. 
 
     [bookmark: pgfId-3614948]Note that both Defense Centers and Series 3 devices are in the midst of a branding transition. The Defense Center is also referred to as the FireSIGHT Management Center, and Series 3 devices are also referred to as FirePOWER devices. Product identification numbers for Defense Centers may begin with FS rather than DC. Similarly, product identification numbers for Series 3 devices may begin with FP rather than 3D. The model numbers otherwise remain unchanged. For example, a DC4000 and an FS4000 refer to the same Defense Center.
 
     [bookmark: pgfId-3609877]Although you can use any Version 5.4.1 Defense Center to manage any Version 5.4.1 device, the DC500 (and to a lesser extent, the DC750) supports a restricted set of FireSIGHT System features. For more information, see Summary of Supported Capabilities by Defense Center Model.
 
     [bookmark: pgfId-3609921]The following tables match the major access control and network management capabilities of the system with the managed devices that support those capabilities, and the licenses you must enable. For brief descriptions of these capabilities, see FireSIGHT System Components.
 
     [bookmark: pgfId-3597736]
 
      
       
        
        [bookmark: pgfId-3608466]Table 1-1 [bookmark: 96898]Supported Access Control Capabilities by Device Model 
 
        
        
         
         	 
           
           [bookmark: pgfId-3601265]Feature or Capability 
          
  
         	 
           
           [bookmark: pgfId-3601270]Series 2 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3601275]Series 3 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3601280]ASA FirePOWER 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3601282]Virtual 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3601287]X-Series 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3601289]License 
          
  
        
 
         
         	[bookmark: pgfId-3601305]access control: basic network control
  
         	[bookmark: pgfId-3601307]yes
  
         	[bookmark: pgfId-3601309]yes
  
         	[bookmark: pgfId-3601311]no VLAN control
  
         	[bookmark: pgfId-3601313]yes
  
         	[bookmark: pgfId-3601315]yes
  
         	[bookmark: pgfId-3601317]Any
  
        
 
         
         	[bookmark: pgfId-3601319]access control: literal URLs
  
         	[bookmark: pgfId-3601321]no
  
         	[bookmark: pgfId-3601323]yes
  
         	[bookmark: pgfId-3601325]yes
  
         	[bookmark: pgfId-3601327]yes
  
         	[bookmark: pgfId-3601329]yes
  
         	[bookmark: pgfId-3601331]Any
  
        
 
         
         	[bookmark: pgfId-3610942]access control: SSL inspection
  
         	[bookmark: pgfId-3610944]no
  
         	[bookmark: pgfId-3610946]yes
  
         	[bookmark: pgfId-3610948]no
  
         	[bookmark: pgfId-3610950]no
  
         	[bookmark: pgfId-3610952]no
  
         	[bookmark: pgfId-3610954]Any
  
        
 
         
         	[bookmark: pgfId-3601333]network discovery: host, user, application
  
         	[bookmark: pgfId-3601335]yes
  
         	[bookmark: pgfId-3601337]yes
  
         	[bookmark: pgfId-3601339]yes
  
         	[bookmark: pgfId-3601341]yes
  
         	[bookmark: pgfId-3601343]yes
  
         	[bookmark: pgfId-3601348]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-3601350]access control: geolocation-based filtering
  
         	[bookmark: pgfId-3601352]no
  
         	[bookmark: pgfId-3601354]yes
  
         	[bookmark: pgfId-3601356]yes
  
         	[bookmark: pgfId-3601358]yes
  
         	[bookmark: pgfId-3601360]no
  
         	[bookmark: pgfId-3601365]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-3601367]Security Intelligence filtering
  
         	[bookmark: pgfId-3601369]no
  
         	[bookmark: pgfId-3601371]yes
  
         	[bookmark: pgfId-3601373]yes
  
         	[bookmark: pgfId-3601375]yes
  
         	[bookmark: pgfId-3601377]yes
  
         	[bookmark: pgfId-3601382]Protection
  
        
 
         
         	[bookmark: pgfId-3601384]intrusion detection and prevention (IPS)
  
         	[bookmark: pgfId-3601386]yes
  
         	[bookmark: pgfId-3601388]yes
  
         	[bookmark: pgfId-3601390]yes
  
         	[bookmark: pgfId-3601392]yes
  
         	[bookmark: pgfId-3601394]yes
  
         	[bookmark: pgfId-3601399]Protection
  
        
 
         
         	[bookmark: pgfId-3601401]file control: by file type
  
         	[bookmark: pgfId-3601403]yes
  
         	[bookmark: pgfId-3601405]yes
  
         	[bookmark: pgfId-3601407]yes
  
         	[bookmark: pgfId-3601409]yes
  
         	[bookmark: pgfId-3601411]yes
  
         	[bookmark: pgfId-3601416]Protection
  
        
 
         
         	[bookmark: pgfId-3601418]file control: archive file inspection
  
         	[bookmark: pgfId-3601420]no
  
         	[bookmark: pgfId-3601422]yes
  
         	[bookmark: pgfId-3601424]yes
  
         	[bookmark: pgfId-3601426]yes
  
         	[bookmark: pgfId-3601428]yes
  
         	[bookmark: pgfId-3601433]Protection
  
        
 
         
         	[bookmark: pgfId-3601435]advanced malware protection (AMP)
  
         	[bookmark: pgfId-3601437]no
  
         	[bookmark: pgfId-3601439]yes
  
         	[bookmark: pgfId-3601441]yes
  
         	[bookmark: pgfId-3601443]yes
  
         	[bookmark: pgfId-3601445]no
  
         	[bookmark: pgfId-3601450]Malware
  
        
 
         
         	[bookmark: pgfId-3601452]access control: application control
  
         	[bookmark: pgfId-3601454]no
  
         	[bookmark: pgfId-3601456]yes
  
         	[bookmark: pgfId-3601458]yes
  
         	[bookmark: pgfId-3601460]yes
  
         	[bookmark: pgfId-3601462]no
  
         	[bookmark: pgfId-3601467]Control
  
        
 
         
         	[bookmark: pgfId-3601469]access control: user control
  
         	[bookmark: pgfId-3601471]no
  
         	[bookmark: pgfId-3601473]yes
  
         	[bookmark: pgfId-3601475]yes
  
         	[bookmark: pgfId-3601477]yes
  
         	[bookmark: pgfId-3601479]no
  
         	[bookmark: pgfId-3601484]Control
  
        
 
         
         	[bookmark: pgfId-3601486]access control: URL filtering by category and reputation
  
         	[bookmark: pgfId-3601488]no
  
         	[bookmark: pgfId-3601490]yes
  
         	[bookmark: pgfId-3601492]yes
  
         	[bookmark: pgfId-3601494]yes
  
         	[bookmark: pgfId-3601496]yes
  
         	[bookmark: pgfId-3601501]URL Filtering
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3624734]
 
      
       
        
        [bookmark: pgfId-3624375]Table 1-2 Supported Administrative and Network Management Capabilities by Device Model 
 
        
        
         
         	 
           
           [bookmark: pgfId-3624389]Feature or Capability 
          
  
         	 
           
           [bookmark: pgfId-3624394]Series 2 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3624399]Series 3 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3624404]ASA FirePOWER 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3624406]Virtual 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3624411]X-Series 
           
 Device 
          
  
         	 
           
           [bookmark: pgfId-3624413]License 
          
  
        
 
         
         	[bookmark: pgfId-3624415]traffic channels
  
         	[bookmark: pgfId-3624417]no
  
         	[bookmark: pgfId-3624419]yes
  
         	[bookmark: pgfId-3624421]no
  
         	[bookmark: pgfId-3624423]no
  
         	[bookmark: pgfId-3624425]no
  
         	[bookmark: pgfId-3624427]Any
  
        
 
         
         	[bookmark: pgfId-3624429]multiple management interfaces
  
         	[bookmark: pgfId-3624431]no
  
         	[bookmark: pgfId-3624433]yes
  
         	[bookmark: pgfId-3624435]no
  
         	[bookmark: pgfId-3624437]no
  
         	[bookmark: pgfId-3624439]no
  
         	[bookmark: pgfId-3624441]Any
  
        
 
         
         	[bookmark: pgfId-3624443]link aggregation
  
         	[bookmark: pgfId-3624445]no
  
         	[bookmark: pgfId-3624447]yes
  
         	[bookmark: pgfId-3624449]no
  
         	[bookmark: pgfId-3624451]no
  
         	[bookmark: pgfId-3624453]no
  
         	[bookmark: pgfId-3624455]Any
  
        
 
         
         	[bookmark: pgfId-3624460]FireSIGHT System web interface
  
         	[bookmark: pgfId-3624462]limited
  
         	[bookmark: pgfId-3624464]limited
  
         	[bookmark: pgfId-3624466]no
  
         	[bookmark: pgfId-3624468]no
  
         	[bookmark: pgfId-3624470]no
  
         	[bookmark: pgfId-3624472]Any
  
        
 
         
         	[bookmark: pgfId-3624474]restricted command line interface (CLI)
  
         	[bookmark: pgfId-3624476]no
  
         	[bookmark: pgfId-3624478]yes
  
         	[bookmark: pgfId-3624480]yes
  
         	[bookmark: pgfId-3624482]yes
  
         	[bookmark: pgfId-3624484]no
  
         	[bookmark: pgfId-3624486]Any
  
        
 
         
         	[bookmark: pgfId-3624488]external authentication
  
         	[bookmark: pgfId-3624490]yes
  
         	[bookmark: pgfId-3624492]yes
  
         	[bookmark: pgfId-3624494]no
  
         	[bookmark: pgfId-3624496]no
  
         	[bookmark: pgfId-3624498]no
  
         	[bookmark: pgfId-3624500]Any
  
        
 
         
         	[bookmark: pgfId-3624505]connect to an eStreamer client
  
         	[bookmark: pgfId-3624507]yes
  
         	[bookmark: pgfId-3624509]yes
  
         	[bookmark: pgfId-3624511]yes
  
         	[bookmark: pgfId-3624513]no
  
         	[bookmark: pgfId-3624515]no
  
         	[bookmark: pgfId-3624517]Any
  
        
 
         
         	[bookmark: pgfId-3624519]Automatic Application Bypass
  
         	[bookmark: pgfId-3624521]yes
  
         	[bookmark: pgfId-3624523]yes
  
         	[bookmark: pgfId-3624525]yes
  
         	[bookmark: pgfId-3624527]yes
  
         	[bookmark: pgfId-3624529]no
  
         	[bookmark: pgfId-3624531]Any
  
        
 
         
         	[bookmark: pgfId-3624533]tap mode
  
         	[bookmark: pgfId-3624535]no
  
         	[bookmark: pgfId-3624537]yes
  
         	[bookmark: pgfId-3624539]no
  
         	[bookmark: pgfId-3624541]no
  
         	[bookmark: pgfId-3624543]no
  
         	[bookmark: pgfId-3624545]Any
  
        
 
         
         	[bookmark: pgfId-3624547]fast-path rules
  
         	[bookmark: pgfId-3624549]no
  
         	[bookmark: pgfId-3624554]8000 Series
  
         	[bookmark: pgfId-3624556]no
  
         	[bookmark: pgfId-3624558]no
  
         	[bookmark: pgfId-3624560]no
  
         	[bookmark: pgfId-3624562]Any
  
        
 
         
         	[bookmark: pgfId-3624564]strict TCP enforcement
  
         	[bookmark: pgfId-3624566]no
  
         	[bookmark: pgfId-3624568]yes
  
         	[bookmark: pgfId-3624570]no
  
         	[bookmark: pgfId-3624572]no
  
         	[bookmark: pgfId-3624574]no
  
         	[bookmark: pgfId-3624579]Protection
  
        
 
         
         	[bookmark: pgfId-3624581]bypass mode for inline sets
  
         	[bookmark: pgfId-3624583]yes
  
         	[bookmark: pgfId-3624585]NetMod/SFP dependent
  
         	[bookmark: pgfId-3624587]no
  
         	[bookmark: pgfId-3624589]no
  
         	[bookmark: pgfId-3624591]no
  
         	[bookmark: pgfId-3624596]Protection
  
        
 
         
         	[bookmark: pgfId-3624598]malware storage pack
  
         	[bookmark: pgfId-3624600]no
  
         	[bookmark: pgfId-3624602]yes
  
         	[bookmark: pgfId-3624604]no
  
         	[bookmark: pgfId-3624606]no
  
         	[bookmark: pgfId-3624608]no
  
         	[bookmark: pgfId-3624613]Malware
  
        
 
         
         	[bookmark: pgfId-3624615]switching, routing, switched and routed aggregate interfaces
  
         	[bookmark: pgfId-3624617]no
  
         	[bookmark: pgfId-3624619]yes
  
         	[bookmark: pgfId-3624621]no
  
         	[bookmark: pgfId-3624623]no
  
         	[bookmark: pgfId-3624625]no
  
         	[bookmark: pgfId-3624630]Control
  
        
 
         
         	[bookmark: pgfId-3624632]NAT policies
  
         	[bookmark: pgfId-3624634]no
  
         	[bookmark: pgfId-3624636]yes
  
         	[bookmark: pgfId-3624638]no
  
         	[bookmark: pgfId-3624640]no
  
         	[bookmark: pgfId-3624642]no
  
         	[bookmark: pgfId-3624647]Control
  
        
 
         
         	[bookmark: pgfId-3624649]device stacking
  
         	[bookmark: pgfId-3624651]no
  
         	[bookmark: pgfId-3624653]3D8140
82xx Family
83xx Family
  
         	[bookmark: pgfId-3624661]no
  
         	[bookmark: pgfId-3624663]no
  
         	[bookmark: pgfId-3624665]no
  
         	[bookmark: pgfId-3624667]Any
  
        
 
         
         	[bookmark: pgfId-3624669]device clustering
  
         	[bookmark: pgfId-3624671]no
  
         	[bookmark: pgfId-3624673]yes
  
         	[bookmark: pgfId-3624675]no
  
         	[bookmark: pgfId-3624677]no
  
         	[bookmark: pgfId-3624682]X-Series based
  
         	[bookmark: pgfId-3624687]Control, except X-Series
  
        
 
         
         	[bookmark: pgfId-3624692]clustered stacks
  
         	[bookmark: pgfId-3624694]no
  
         	[bookmark: pgfId-3624696]3D8140
82xx Family
83xx Family
  
         	[bookmark: pgfId-3624704]no
  
         	[bookmark: pgfId-3624706]no
  
         	[bookmark: pgfId-3624708]no
  
         	[bookmark: pgfId-3624713]Control
  
        
 
         
         	[bookmark: pgfId-3624718]VPN
  
         	[bookmark: pgfId-3624720]no
  
         	[bookmark: pgfId-3624722]yes
  
         	[bookmark: pgfId-3624724]no
  
         	[bookmark: pgfId-3624726]no
  
         	[bookmark: pgfId-3624728]no
  
         	[bookmark: pgfId-3624733]VPN
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3633948][bookmark: 62062]Configurations that Restart the Snort Process
 
     [bookmark: pgfId-3633949]The Snort process always restarts when applying any of the configurations listed below.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-3633950] 
      Caution Applying some configurations requires the Snort process to restart, which temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic. 
       
       
 
      
 
     
 
     [bookmark: pgfId-3633954]Access Control Policy
 
      
      	 [bookmark: pgfId-3640592]apply a policy for the first time
 
      	 [bookmark: pgfId-3642564]add or remove a URL category and reputation condition on the URLs tab in an access control rule
 
      	 [bookmark: pgfId-3642659]associate an intrusion policy or file policy on the Inspection tab in an access control rule, or subsequently remove the policy by selecting  None 
 
     
 
     [bookmark: pgfId-3640621]Access Control Policy Advanced Setting
 
      
      	 [bookmark: pgfId-3639473]disable  Inspect Traffic During Policy Apply under General Settings
 
      	 [bookmark: pgfId-3640738]change a value under Files and Malware Settings
 
      	 [bookmark: pgfId-3640786]associate an SSL policy under SSL Policy Settings, or subsequently remove the policy by selecting  None 
 
      	 [bookmark: pgfId-3642109]enable or disable adaptive profiles under Detection Enhancement Settings
 
     
 
     [bookmark: pgfId-3641016]Security Intelligence
 
      
      	 [bookmark: pgfId-3641098]change a Security Intelligence list, except via the  Whitelist Now or  Blacklist Now option on the right-click menu
 
     
 
     [bookmark: pgfId-3643093]SSL Policy
 
      
      	 [bookmark: pgfId-3643110]add or remove a URL category and reputation condition on the Category tab in an SSL rule
 
     
 
     [bookmark: pgfId-3643223]File Policy
 
      
      	 [bookmark: pgfId-3643224]enable or disable archive file inspection
 
      	 [bookmark: pgfId-3643225]add a file type or file category to a file rule, or subsequently remove it from the rule
 
      	 [bookmark: pgfId-3643226]change a file rule action to or from  Detect Files or  Block Malware 
 
      	 [bookmark: pgfId-3643227]enable or disable  Store Files in a file rule
 
     
 
     [bookmark: pgfId-3641057]Network Analysis Policy
 
     [bookmark: pgfId-3641175] – change the value for an IMAP, POP, or SMTP preprocessor Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth
 
     [bookmark: pgfId-3641413]Device Management
 
      
      	 [bookmark: pgfId-3641414]Routing—add a Series 3 routed interface or virtual router
 
      	 [bookmark: pgfId-3641517]VPN—add or remove a VPN
 
      	 [bookmark: pgfId-3641418]MTU—change the MTU value (Series 2) or the highest MTU value (Series 3) for a non-management interface
 
      	 [bookmark: pgfId-3642460]Device high availability—change a high-availability state sharing option
 
      	 [bookmark: pgfId-3641561]AAB— activate AAB
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3641421]Note Automatic Application Bypass (AAB) is activated only when it is enabled and an excessive amount of time is spent processing a single packet. If AAB engages, the Snort process restarts.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3641281]Pre-Apply Updates
 
      
      	 [bookmark: pgfId-3642016]apply an access control or intrusion policy after importing an intrusion rule update that includes a new or updated shared object rule
 
      	 [bookmark: pgfId-3642017]apply an access control policy after installing a vulnerability database (VDB) update
 
     
 
     [bookmark: pgfId-3633974]System Updates
 
     [bookmark: pgfId-3633975]Installing a system update or patch that includes a binary change. Binary changes can include changes to Snort, a preprocessor, the vulnerability database (VDB), or a shared object rule. Note that in the case of a managed device, a patch that does not include a binary change can sometimes require a Snort restart. 
 
    
 
     
      [bookmark: pgfId-3633977][bookmark: 31147]How Snort Restarts Affect Traffic
 
     [bookmark: pgfId-3633978]As seen in the following table, the effect of Snort restarts on traffic depends on the model of the managed device and how the device handles traffic. 
 
     [bookmark: pgfId-3634031]
 
      
       
        
        [bookmark: pgfId-3633984]Table 1-3 Restart Traffic Affects by Managed Device Model 
 
        
        
         
         	 
           
           [bookmark: pgfId-3633990]On this model... 
          
  
         	 
           
           [bookmark: pgfId-3633992]Configured as... 
          
  
         	 
           
           [bookmark: pgfId-3633994]Traffic during restart is... 
          
  
        
 
         
         	 [bookmark: pgfId-3633996]Series 2, Series 3, virtual
  
         	[bookmark: pgfId-3633998]inline, Failsafe enabled or disabled
  
         	[bookmark: pgfId-3634000]passed without inspection* (a few packets might drop if Failsafe is disabled and Snort is busy but not down)
  
        
 
         
         	[bookmark: pgfId-3634004]passive
  
         	[bookmark: pgfId-3634006]uninterrupted, not inspected
  
        
 
         
         	[bookmark: pgfId-3634008]3D9900, Series 3
  
         	[bookmark: pgfId-3634010]inline, tap mode
  
         	[bookmark: pgfId-3634012]uninterrupted, not inspected*
  
        
 
         
         	[bookmark: pgfId-3634014]Series 3
  
         	[bookmark: pgfId-3634016]routed, switched, transparent
  
         	[bookmark: pgfId-3634018]dropped
  
        
 
         
         	 [bookmark: pgfId-3634020]ASA FirePOWER
  
         	[bookmark: pgfId-3634022]routed or transparent with fail-open (Permit Traffic)
  
         	[bookmark: pgfId-3634024]passed without inspection
  
        
 
         
         	[bookmark: pgfId-3634028]routed or transparent with fail-close (Close Traffic)
  
         	[bookmark: pgfId-3634030]dropped
  
        
 
         
         	 [bookmark: pgfId-3634183]*Series 2 drops traffic when you change the MTU on a sensing interface; otherwise, traffic is handeled as shown
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3624742][bookmark: 58759][bookmark: 56824][bookmark: marker-3624738]Introduction to the Defense Center
 
    [bookmark: pgfId-3624256]A Defense Center provides a centralized management console and database repository for your FireSIGHT System deployment. Defense Centers aggregate and correlate intrusion, file, malware, discovery, connection, and performance data, assessing the impact of events on particular hosts and tagging hosts with indications of compromise. This allows you to monitor the information that your devices report in relation to one another, and to assess and control the overall activity that occurs on your network. Defense Centers also control the network management features on your devices: switching, routing, NAT, VPN, and so on.
 
    [bookmark: pgfId-3574816]Key features of the Defense Center include:
 
     
     	 [bookmark: pgfId-3574817]device, license, and policy management
 
     	 [bookmark: pgfId-3574818]event and contextual information displayed in tables, graphs, and charts
 
     	 [bookmark: pgfId-3574819]health and performance monitoring
 
     	 [bookmark: pgfId-3574820]external notification and alerting
 
     	 [bookmark: pgfId-3574821]correlation, indications of compromise, and remediation features for real-time threat response
 
     	 [bookmark: pgfId-3574822]custom and template-based reporting
 
     	 [bookmark: pgfId-3574747]a high availability (redundancy) feature to ensure continuity of operations
 
    
 
    [bookmark: pgfId-3587258]Series 2 and Series 3 Defense Centers are fault-tolerant, purpose-built physical network appliances available from Cisco. You can also deploy 64-bit virtual Defense Centers as ESXi hosts using the VMware vSphere Hypervisor or vCloud Director environment. Any Defense Center can manage any type of device: physical, virtual, Cisco ASA with FirePOWER Services, and Cisco NGIPS for Blue Coat X-Series.
 
    [bookmark: pgfId-3588376]Defense Centers have a range of device management, event storage, host monitoring, and user monitoring capabilities. Note that because of resource and architecture limitations, the DC500 (and to a lesser extent, the DC750) supports a restricted set of FireSIGHT System features.
 
    [bookmark: pgfId-3614981]Note that both Defense Centers and Series 3 devices are in the midst of a branding transition. The Defense Center is also referred to as the FireSIGHT Management Center, and Series 3 devices are also referred to as FirePOWER devices. Product identification numbers for Defense Centers may begin with FS rather than DC. Similarly, product identification numbers for Series 3 devices may begin with FP rather than 3D. The model numbers otherwise remain unchanged. For example, a DC4000 and an FS4000 refer to the same Defense Center.
 
     
      
    
 
    
 
    [bookmark: pgfId-3588276]Note Although Cisco no longer ships new Series 2 Defense Centers, you can update or reimage them to Version 5.4.1. Note that reimaging results in the loss of almost all configuration and event data on the appliance. For more information, see the FireSIGHT System Installation Guide.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3576570][bookmark: 11532]Summary of Supported Capabilities by Defense Center Model
 
     [bookmark: pgfId-3588482]When running Version 5.4.1, all Defense Centers have similar capabilities, with the primary differences being capacity and speed. Defense Center models vary in terms of how many devices they can manage, how many events they can store, and how many hosts and users they can monitor. For more information, see:
 
      
      	 [bookmark: pgfId-3579908]Managing Devices
 
      	 [bookmark: pgfId-3579912]Configuring Database Event Limits
 
      	 [bookmark: pgfId-3579916]Understanding FireSIGHT Host and User License Limits
 
     
 
     [bookmark: pgfId-3589343]Although you can use any Version 5.4.1 Defense Center to manage any Version 5.4.1 device, the DC500 (and to a lesser extent, the DC750) supports a restricted set of FireSIGHT System features. Also, many system capabilities are limited by your devices’ license and model; see Summary of Supported Capabilities by Managed Device Model. 
 
      
       
        
        [bookmark: pgfId-3583727]Table 1-4 [bookmark: 69915]Supported Access Control Capabilities by Defense Center Model 
 
        
        
         
         	 
           
           [bookmark: pgfId-3583737]Feature or Capability 
          
  
         	 
           
           [bookmark: pgfId-3583742]Series 2 
           
 Defense Center 
          
  
         	 
           
           [bookmark: pgfId-3583750]Series 3 
           
 Defense Center 
          
  
         	 
           
           [bookmark: pgfId-3583755]Virtual 
           
 Defense Center 
          
  
         	 
           
           [bookmark: pgfId-3583760]License 
          
  
        
 
         
         	[bookmark: pgfId-3583762]manage devices performing simple network-based access control
  
         	[bookmark: pgfId-3583764]yes
  
         	[bookmark: pgfId-3583766]yes
  
         	[bookmark: pgfId-3583768]yes
  
         	[bookmark: pgfId-3583770]Any
  
        
 
         
         	[bookmark: pgfId-3583772]manage devices performing URL control by literal (manually entered) URL
  
         	[bookmark: pgfId-3583774]yes
  
         	[bookmark: pgfId-3583776]yes
  
         	[bookmark: pgfId-3583778]yes
  
         	[bookmark: pgfId-3583780]Any
  
        
 
         
         	[bookmark: pgfId-3617356]manage devices performing SSL inspection
  
         	[bookmark: pgfId-3617358]yes
  
         	[bookmark: pgfId-3617360]yes
  
         	[bookmark: pgfId-3617362]yes
  
         	[bookmark: pgfId-3617367]Any
  
        
 
         
         	[bookmark: pgfId-3583782]collect discovery data (host, application, and user) reported by managed devices and build a network map for your organization
  
         	[bookmark: pgfId-3583784]yes
  
         	[bookmark: pgfId-3583786]yes
  
         	[bookmark: pgfId-3583788]yes
  
         	[bookmark: pgfId-3583793]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-3583795]enhance discovery with geolocation (country and continent) data, and manage devices performing geolocation-based access control
  
         	[bookmark: pgfId-3583803]DC1000, DC3000
  
         	[bookmark: pgfId-3583805]yes
  
         	[bookmark: pgfId-3583807]yes
  
         	[bookmark: pgfId-3583812]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-3583814]manage devices performing Security Intelligence filtering (blacklisting)
  
         	[bookmark: pgfId-3583822]DC1000, DC3000
  
         	[bookmark: pgfId-3583824]yes
  
         	[bookmark: pgfId-3583826]yes
  
         	[bookmark: pgfId-3583831]Protection
  
        
 
         
         	[bookmark: pgfId-3583833]manage an intrusion detection and prevention (IPS) deployment
  
         	[bookmark: pgfId-3583835]yes
  
         	[bookmark: pgfId-3583837]yes
  
         	[bookmark: pgfId-3583839]yes
  
         	[bookmark: pgfId-3583844]Protection
  
        
 
         
         	[bookmark: pgfId-3583846]manage devices performing simple file control by file type
  
         	[bookmark: pgfId-3583848]yes
  
         	[bookmark: pgfId-3583850]yes
  
         	[bookmark: pgfId-3583852]yes
  
         	[bookmark: pgfId-3583857]Protection
  
        
 
         
         	[bookmark: pgfId-3583859]manage devices performing archive file inspection
  
         	[bookmark: pgfId-3583867]DC1000, DC3000
  
         	[bookmark: pgfId-3583869]yes
  
         	[bookmark: pgfId-3583871]yes
  
         	[bookmark: pgfId-3583876]Protection
  
        
 
         
         	[bookmark: pgfId-3583878]manage devices performing application control
  
         	[bookmark: pgfId-3583880]yes
  
         	[bookmark: pgfId-3583882]yes
  
         	[bookmark: pgfId-3583884]yes
  
         	[bookmark: pgfId-3583889]Control
  
        
 
         
         	[bookmark: pgfId-3583891]manage devices performing user control
  
         	[bookmark: pgfId-3583899]DC1000, DC3000
  
         	[bookmark: pgfId-3583901]yes
  
         	[bookmark: pgfId-3583903]yes
  
         	[bookmark: pgfId-3583908]Control
  
        
 
         
         	[bookmark: pgfId-3583910]manage devices performing URL filtering by category and reputation
  
         	[bookmark: pgfId-3583918]DC1000, DC3000
  
         	[bookmark: pgfId-3583920]yes
  
         	[bookmark: pgfId-3583922]yes
  
         	[bookmark: pgfId-3583924]URL Filtering
  
        
 
         
         	[bookmark: pgfId-3583939]manage an advanced malware protection (AMP) deployment and install a malware storage pack
  
         	[bookmark: pgfId-3583947]DC1000, DC3000
  
         	[bookmark: pgfId-3583949]yes
  
         	[bookmark: pgfId-3583951]yes
  
         	[bookmark: pgfId-3583956]Malware
  
        
 
         
         	[bookmark: pgfId-3583961]receive endpoint-based malware (FireAMP) events from your FireAMP deployment
  
         	[bookmark: pgfId-3583966]yes
  
         	[bookmark: pgfId-3583968]yes
  
         	[bookmark: pgfId-3583970]yes
  
         	[bookmark: pgfId-3583975]FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-3583980]connect to an eStreamer, host input, or database client
  
         	[bookmark: pgfId-3583982]yes
  
         	[bookmark: pgfId-3583984]yes
  
         	[bookmark: pgfId-3583986]yes
  
         	[bookmark: pgfId-3583988]Any
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3582145]
 
      
       
        
        [bookmark: pgfId-3584844]Table 1-5 Supported Network Management and Redundancy Capabilities by Defense Center Model 
 
        
        
         
         	 
           
           [bookmark: pgfId-3584854]Feature or Capability 
          
  
         	 
           
           [bookmark: pgfId-3584859]Series 2 
           
 Defense Center 
          
  
         	 
           
           [bookmark: pgfId-3584867]Series 3 
           
 Defense Center 
          
  
         	 
           
           [bookmark: pgfId-3584872]Virtual 
           
 Defense Center 
          
  
         	 
           
           [bookmark: pgfId-3584877]License 
          
  
        
 
         
         	[bookmark: pgfId-3584879]separate and manage internal and external traffic using traffic channels
  
         	[bookmark: pgfId-3584881]no
  
         	[bookmark: pgfId-3584883]yes
  
         	[bookmark: pgfId-3584885]yes
  
         	[bookmark: pgfId-3584887]Any
  
        
 
         
         	[bookmark: pgfId-3584889]isolate and manage traffic on different networks using multiple management interfaces
  
         	[bookmark: pgfId-3584891]no
  
         	[bookmark: pgfId-3584893]yes
  
         	[bookmark: pgfId-3584895]yes
  
         	[bookmark: pgfId-3584897]Any
  
        
 
         
         	[bookmark: pgfId-3584902]establish Defense Center redundancy (high availability)
  
         	[bookmark: pgfId-3584910]DC1000, DC3000
  
         	[bookmark: pgfId-3584918]DC1500, DC2000, DC3500, DC4000
  
         	[bookmark: pgfId-3584926]no
  
         	[bookmark: pgfId-3584928]Any
  
        
 
         
         	[bookmark: pgfId-3584930]manage device-based redundancy and resource sharing—stacks, clusters, and clustered stacks
  
         	[bookmark: pgfId-3584932]yes
  
         	[bookmark: pgfId-3584934]yes
  
         	[bookmark: pgfId-3584936]yes
  
         	[bookmark: pgfId-3584941]Control
  
        
 
         
         	[bookmark: pgfId-3584943]manage devices with hardware-dependent network management features: fast-path rules, strict TCP enforcement, bypass mode, tap mode, switching and routing, NAT, VPN
  
         	[bookmark: pgfId-3584945]yes
  
         	[bookmark: pgfId-3584947]yes
  
         	[bookmark: pgfId-3584949]yes
  
         	[bookmark: pgfId-3584951]feature dependent
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3562872][bookmark: 71493]Defense Centers and Devices Delivered with Version 5.4.X
 
     
      
       
       [bookmark: pgfId-3622624]Table 1-6 Version 5.4.1 FireSIGHT System Defense Centers and Devices 
 
       
       
        
        	 
          
          [bookmark: pgfId-3622632]Models/Family 
         
  
        	 
          
          [bookmark: pgfId-3622634]Series 
         
  
        	 
          
          [bookmark: pgfId-3622636]Type 
         
  
        	 
          
          [bookmark: pgfId-3622638]Version 5.4.x 
         
  
       
 
        
        	[bookmark: pgfId-3622643]70xx Family:
 
          
          	 [bookmark: pgfId-3622644]3D7010/7020/7030/7050
 
         
  
        	[bookmark: pgfId-3622655]Series 3 FirePOWER (7000 Series)
  
        	[bookmark: pgfId-3622657]device
  
        	[bookmark: pgfId-3622662]Version 5.4.0.x
  
       
 
        
        	[bookmark: pgfId-3622667]71xx Family:
 
          
          	 [bookmark: pgfId-3622668]3D7110/7120
 
          	 [bookmark: pgfId-3622669]3D7115/7125
 
          	 [bookmark: pgfId-3622670]AMP7150
 
         
  
        	[bookmark: pgfId-3622681]Series 3 FirePOWER (7000 Series)
  
        	[bookmark: pgfId-3622683]device
  
        	[bookmark: pgfId-3622688]Version 5.4.0.x
  
       
 
        
        	[bookmark: pgfId-3622693]81xx Family:
 
          
          	 [bookmark: pgfId-3622694]3D8120/8130/8140
 
          	 [bookmark: pgfId-3622695]AMP8150
 
         
  
        	[bookmark: pgfId-3622706]Series 3 FirePOWER (8000 Series)
  
        	[bookmark: pgfId-3622708]device
  
        	[bookmark: pgfId-3622713]Version 5.4.0.x
  
       
 
        
        	[bookmark: pgfId-3622718]82xx Family:
 
          
          	 [bookmark: pgfId-3622719]3D8250
 
          	 [bookmark: pgfId-3622720]3D8260/8270/8290
 
         
  
        	[bookmark: pgfId-3622731]Series 3 FirePOWER (8000 Series)
  
        	[bookmark: pgfId-3622733]device
  
        	[bookmark: pgfId-3622738]Version 5.4.0.x
  
       
 
        
        	[bookmark: pgfId-3622743]83xx Family:
 
          
          	 [bookmark: pgfId-3622744]3D8350
 
          	 [bookmark: pgfId-3622745]3D8360/8370/8390
 
          	 [bookmark: pgfId-3622882]AMP8350
 
          	 [bookmark: pgfId-3622895]AMP8360/8370/8390
 
         
  
        	[bookmark: pgfId-3622756]Series 3 FirePOWER (8000 Series)
  
        	[bookmark: pgfId-3622758]device
  
        	[bookmark: pgfId-3622763]Version 5.4.0.x
  
       
 
        
        	[bookmark: pgfId-3622765]64-bit virtual devices
  
        	[bookmark: pgfId-3622767]n/a
  
        	[bookmark: pgfId-3622769]device
  
        	[bookmark: pgfId-3622774]Version 5.4.0.x
  
       
 
        
        	[bookmark: pgfId-3622778]Cisco NGIPS for Blue Coat X-Series
  
        	[bookmark: pgfId-3622781]n/a
  
        	[bookmark: pgfId-3622783]device
  
        	[bookmark: pgfId-3622788]Version 5.4.0.x
  
       
 
        
        	[bookmark: pgfId-3622793]ASA FirePOWER:
 
          
          	 [bookmark: pgfId-3623423]ASA5512-X
 
          	 [bookmark: pgfId-3623381]ASA5515-X
 
          	 [bookmark: pgfId-3623399]ASA5525-X
 
          	 [bookmark: pgfId-3623400]ASA5545-X
 
          	 [bookmark: pgfId-3623401]ASA5555-X
 
          	 [bookmark: pgfId-3622794]ASA5585-X-SSP-10
 
          	 [bookmark: pgfId-3622795]ASA5585-X-SSP-20
 
          	 [bookmark: pgfId-3622796]ASA5585-X-SSP-40
 
          	 [bookmark: pgfId-3622797]ASA5585-X-SSP-60
 
         
  
        	[bookmark: pgfId-3622799]n/a
  
        	[bookmark: pgfId-3622801]device
  
        	[bookmark: pgfId-3622806]Version 5.4.0.x
  
       
 
        
        	[bookmark: pgfId-3623360]ASA FirePOWER:
 
          
          	 [bookmark: pgfId-3633487]ASA5506-X
 
          	 [bookmark: pgfId-3633488]ASA5506H-X
 
          	 [bookmark: pgfId-3633489]ASA5506W-X 
 
          	 [bookmark: pgfId-3633490]ASA5508-X
 
          	 [bookmark: pgfId-3622818]ASA5516-X
 
          	 [bookmark: pgfId-3623334]ISA 3000
 
         
  
        	[bookmark: pgfId-3622823]n/a
  
        	[bookmark: pgfId-3622825]device
  
        	[bookmark: pgfId-3622830]Version 5.4.1.x
  
       
 
        
        	[bookmark: pgfId-3622838]Series 3 Defense Centers:
 
          
          	 [bookmark: pgfId-3622842]DC750/1500/3500
 
          	 [bookmark: pgfId-3622843]DC2000/4000
 
         
  
        	[bookmark: pgfId-3622848]Series 3
  
        	[bookmark: pgfId-3622852]Defense Center
  
        	[bookmark: pgfId-3622858]Version 5.4.1.x
  
       
 
        
        	[bookmark: pgfId-3622863]64-bit virtual Defense Centers
  
        	[bookmark: pgfId-3622865]n/a
  
        	[bookmark: pgfId-3622869]Defense Center
  
        	[bookmark: pgfId-3622875]Version 5.4.1.x
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3615014]Note that both Defense Centers and Series 3 devices are in the midst of a branding transition. The Defense Center is also referred to as the FireSIGHT Management Center, and Series 3 devices are also referred to as FirePOWER devices. Product identification numbers for Defense Centers may begin with FS rather than DC. Similarly, product identification numbers for Series 3 devices may begin with FP rather than 3D. The model numbers otherwise remain unchanged. For example, a DC4000 and an FS4000 refer to the same Defense Center.
 
    [bookmark: pgfId-3614091]Although Cisco no longer ships new Series 2 appliances, you can update or reimage Series 2 devices and Defense Centers running earlier versions of the system to Version 5.4.1. Note that reimaging results in the loss of almost all configuration and event data on the appliance. For more information, see the FireSIGHT System Installation Guide.
 
     
      
    
 
    
 
    [bookmark: pgfId-3482346]Tip You can migrate specific configuration and event data from a Version 4.10.3 deployments to a Version 5.2 deployment, which you can then update to Version 5.4.1. For more information, see the FireSIGHT System Migration Guide for Version 5.2.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3444516][bookmark: 85784]FireSIGHT System Components
 
    [bookmark: pgfId-3390816]The topics that follow describe some of the key capabilities of the FireSIGHT System that contribute to your organization’s security, acceptable use policy, and traffic management strategy:
 
     
     	 [bookmark: pgfId-3390806]Redundancy and Resource Sharing
 
     	 [bookmark: pgfId-3381408]Network Traffic Management
 
     	 [bookmark: pgfId-3380264]FireSIGHT
 
     	 [bookmark: pgfId-3610424]Access Control
 
     	 [bookmark: pgfId-3610425]SSL Inspection
 
     	 [bookmark: pgfId-3610429]Intrusion Detection and Prevention
 
     	 [bookmark: pgfId-3380276]Advanced Malware Protection and File Control
 
     	 [bookmark: pgfId-3380284]Application Programming Interfaces
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-3390727]Tip Many FireSIGHT System features are appliance model, license, and user role dependent. This documentation includes information about which FireSIGHT System licenses and devices are required for each feature, and which user roles have permission to complete each procedure. For more information, see Documentation Conventions.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3397824][bookmark: 62508]Redundancy and Resource Sharing
 
     [bookmark: pgfId-3415227]The redundancy and resource-sharing features of the FireSIGHT System allow you to ensure continuity of operations and to combine the processing resources of multiple physical devices.
 
     [bookmark: pgfId-3397829]Defense Center High Availability
 
     [bookmark: pgfId-3384661]To ensure continuity of operations, a Defense Center high availability feature allows you to designate redundant DC1000, DC1500, DC2000, DC3000, DC3500, or DC4000 Defense Centers to manage devices. Event data streams from managed devices to both Defense Centers; certain configuration elements are maintained on both Defense Centers. If one Defense Center fails, you can monitor your network without interruption using the other Defense Center.
 
     [bookmark: pgfId-3420755]Device Stacking
 
     [bookmark: pgfId-3420756]Device stacking allows you to increase the amount of traffic inspected on a network segment by connecting two to four physical devices in a stacked configuration. When you establish a stacked configuration, you combine the resources of each stacked device into a single, shared configuration.
 
     [bookmark: pgfId-3381534]Device Clustering
 
     [bookmark: pgfId-3381535]Device clustering (sometimes called device high availability) allows you to establish redundancy of networking functionality and configuration data between two or more Series 3 devices or stacks. Clustering two or more peer devices or stacks results in a single logical system for policy applies, system updates, and registration. With device clustering, the system can fail over either manually or automatically.
 
     [bookmark: pgfId-3381539]In most cases, you can achieve Layer 3 redundancy without clustering devices by using SFRP. SFRP allows devices to act as redundant gateways for specified IP addresses. With network redundancy, you can configure two or more devices or stacks to provide identical network connections, ensuring connectivity for other hosts on the network.
 
     [bookmark: pgfId-3438059]Load Balancing with Cisco NGIPS for Blue Coat X-Series
 
     [bookmark: pgfId-3511991]You can take advantage of the X-Series platform’s load balancing and redundancy benefits (comparable to Cisco physical device clustering) by deploying Cisco NGIPS for Blue Coat X-Series as individual VAPs in a multi-member VAP group on the X-Series platform. You then manage these VAP groups using the Defense Center. For more information, see the Cisco NGIPS for Blue Coat X-Series Installation and Configuration Guide.
 
    
 
     
      [bookmark: pgfId-3380301][bookmark: 57735]Network Traffic Management
 
     [bookmark: pgfId-3415237]The FireSIGHT System’s network traffic management features allow managed devices to act as part of your organization’s network infrastructure. You can configure Series 3 devices to serve in a switched, routed, or hybrid (switched and routed) environment; to perform network address translation (NAT); and to build secure virtual private network (VPN) tunnels.
 
     [bookmark: pgfId-3380304][bookmark: 75036]Switching
 
     [bookmark: pgfId-3380308]You can configure the FireSIGHT System in a Layer 2 deployment so that it provides packet switching between two or more network segments. In a Layer 2 deployment, you configure switched interfaces and virtual switches on managed devices to operate as standalone broadcast domains. A virtual switch uses the MAC address from a host to determine where to send packets. You can also group multiple physical interfaces into a single logical link that provides packet switching between two endpoints in your network. The endpoints can be two FirePOWER managed devices, or a FirePOWER managed device connected to a third-party access switch. 
 
     [bookmark: pgfId-3380309]Routing
 
     [bookmark: pgfId-3380313]You can configure the FireSIGHT System in a Layer 3 deployment so that it routes traffic between two or more interfaces. In a Layer 3 deployment, you configure routed interfaces and virtual routers on managed devices to receive and forward traffic. The system routes packets by making packet forwarding decisions according to the destination IP address. Routers obtain the destination from the outgoing interface based on the forwarding criteria, and access control rules designate the security policies to apply. 
 
     [bookmark: pgfId-3380314]When you configure virtual routers, you can define static routes. In addition, you can configure Routing Information Protocol (RIP) and Open Shortest Path First (OSPF) dynamic routing protocols. You can also configure a combination of static routes and RIP or static routes and OSPF. You can set up DHCP relay for each virtual router you configure.
 
     [bookmark: pgfId-3380318]If you use both virtual switches and virtual routers in your Cisco appliance configuration, you can configure associated hybrid interfaces to bridge traffic between them. These utilities analyze traffic to determine its type and the appropriate response (route, switch, or otherwise). You can also group multiple physical interfaces into a single logical link that routes traffic between two endpoints in your network. The endpoints can be two FirePOWER managed devices, or a FirePOWER managed device connected to a third-party router.
 
     [bookmark: pgfId-3380319]NAT
 
     [bookmark: pgfId-3380320]In a Layer 3 deployment, you can configure network address translation (NAT). You can expose an internal server to an external network, or allow an internal host or server to connect to an external application. You can also configure NAT to hide private network addresses from an external network by using a block of IP addresses, or by using a limited block of IP addresses and port translation.
 
     [bookmark: pgfId-3380322]VPN
 
     [bookmark: pgfId-3426170]A virtual private network (VPN) is a network connection that establishes a secure tunnel between endpoints via a public source, such as the Internet or other network. You can configure the FireSIGHT System to build secure VPN tunnels between the virtual routers of Series 3 devices.
 
    
 
     
      [bookmark: pgfId-3380329][bookmark: marker-3380324][bookmark: 22665]FireSIGHT
 
     [bookmark: pgfId-3420659][bookmark: marker-3420652]FireSIGHT™ is Cisco’s discovery and awareness technology that collects information about hosts, operating systems, applications, users, files, networks, geolocation information, and vulnerabilities, in order to provide you with a complete view of your network.
 
     [bookmark: pgfId-3382169]You can use the Defense Center’s web interface to view and analyze data collected by the system. You can also use this data to help you perform access control and modify intrusion rule states. In addition, you can generate and track indications of compromise on hosts on your network based on correlated event data for the hosts.
 
    
 
     
      [bookmark: pgfId-3380345][bookmark: 74363]Access Control
 
     [bookmark: pgfId-3610147]Access control is a policy-based feature that allows you to specify, inspect, and log the traffic that can traverse your network. An access control policy determines how the system handles traffic on your network. 
 
     [bookmark: pgfId-3610148]The simplest access control policy directs its target devices to handle all traffic using its default action. You can set this default action to block or trust all traffic without further inspection, or to inspect traffic for intrusions and discovery data.
 
     [bookmark: pgfId-3610158]A more complex access control policy can blacklist traffic based on Security Intelligence data, as well as use access control rules to exert granular control over network traffic logging and handling. These rules can be simple or complex, matching and inspecting traffic using multiple criteria; you can control traffic by security zone, network or geographical location, VLAN, port, application, requested URL, and user. Advanced access control options include decryption, preprocessing, and performance. 
 
     [bookmark: pgfId-3610219]Each access control rule also has an action, which determines whether you monitor, trust, block, or allow matching traffic. When you allow traffic, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network.
 
    
 
     
      [bookmark: pgfId-3610344][bookmark: 64826]SSL Inspection
 
     [bookmark: pgfId-3610388]SSL inspection is a policy-based feature that allows you to handle encrypted traffic without decryption, or decrypt encrypted traffic for further access control inspection. You can choose to block a source of untrusted encrypted traffic without decrypting or further analyzing the traffic, or you can choose to not decrypt encrypted traffic and inspect it with access control instead. 
 
     [bookmark: pgfId-3612099]For further insight into encrypted traffic, you can use public key certificates and paired private keys you upload to the system to decrypt encrypted traffic traversing your network, then inspect the decrypted traffic with access control as if it was never encrypted. If the system does not block the decrypted traffic post-analysis, it reencrypts the traffic before passing it to the destination host. The system can log details about encrypted connections as it acts on them.
 
    
 
     
      [bookmark: pgfId-3380356][bookmark: 22716]Intrusion Detection and Prevention
 
     [bookmark: pgfId-3610532]Intrusion detection and prevention is the system’s last line of defense before traffic is allowed to its destination. Intrusion policies are defined sets of intrusion detection and prevention configurations invoked by your access control policy. Using intrusion rules and other settings, these policies inspect traffic for security violations and, in inline deployments, can block or alter malicious traffic. 
 
     [bookmark: pgfId-3610700]Cisco delivers several intrusion policies with the FireSIGHT System. By using system-provided policies you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states (enabled or disabled), as well as provides the initial configurations for other advanced settings. An enabled rule causes the system to generate intrusion events for (and optionally block) traffic matching the rule.
 
     [bookmark: pgfId-3610704]If the system-provided policies do not fully address the security needs of your organization, custom policies can improve the performance of the system in your environment and can provide a focused view of the malicious traffic and policy violations occurring on your network. By creating and tuning custom policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions.
 
    
 
     
      [bookmark: pgfId-3422158][bookmark: 54741]Advanced Malware Protection and File Control
 
     [bookmark: pgfId-3422021]To help you identify and mitigate the effects of malware, the FireSIGHT System’s file control, network file trajectory, and advanced malware protection components can detect, track, capture, analyze, and optionally block the transmission of files (including malware files and nested files inside archive files) in network traffic.
 
     [bookmark: pgfId-3380364][bookmark: 72592]File Control
 
     [bookmark: pgfId-3380365]File control allows managed devices to detect and block your users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols. You configure file control as part of your overall access control configuration; file policies associated with access control rules inspect network traffic that meets rule conditions.
 
     [bookmark: pgfId-3380366][bookmark: 43653]Network-Based Advanced Malware Protection (AMP)
 
     [bookmark: pgfId-3380367]Network-based advanced malware protection (AMP) allows the system to inspect network traffic for malware in several types of files. Appliances can store detected files for further analysis, either to their hard drive or (for some models) a malware storage pack.
 
     [bookmark: pgfId-3485677]Regardless of whether you store a detected file, you can submit it to the Collective Security Intelligence Cloud for a simple known-disposition lookup using the file’s SHA-256 hash value. You can also submit files for dynamic analysis, which produces a threat score. Using this contextual information, you can configure the system to block or allow specific files.
 
     [bookmark: pgfId-3393413]You configure malware protection as part of your overall access control configuration; file policies associated with access control rules inspect network traffic that meets rule conditions.
 
     [bookmark: pgfId-3380380][bookmark: 54732]FireAMP Integration
 
     [bookmark: pgfId-3380387]FireAMP is Cisco’s enterprise-class, advanced malware analysis and protection solution that discovers, understands, and blocks advanced malware outbreaks, advanced persistent threats, and targeted attacks.
 
     [bookmark: pgfId-3380394]If your organization has a FireAMP subscription, individual users install FireAMP Connectors[bookmark: marker-3380395] on their computers and mobile devices (also called endpoints). These lightweight agents communicate with the Cisco cloud, which in turn communicates with the Defense Center. 
 
     [bookmark: pgfId-3485973]If your organization’s security policy does not allow for the use of a traditional cloud server connection, you can acquire and configure Cisco’s private, on-premises cloud solution, the FireAMP Private Cloud, which is a virtual machine that acts as a compressed, local version of the public Cisco cloud. 
 
     [bookmark: pgfId-3612166]After you configure the Defense Center to connect to the cloud, you can use the Defense Center web interface to view endpoint-based malware events generated as a result of scans, detections, and quarantines on the endpoints in your organization. The Defense Center also uses FireAMP data to generate and track indications of compromise on hosts, as well as display network file trajectories.
 
     [bookmark: pgfId-3380415]Use the FireAMP portal (http://amp.sourcefire.com/) to configure your FireAMP deployment. The portal helps you quickly identify and quarantine malware. You can identify outbreaks when they occur, track their trajectories, understand their effects, and learn how to successfully recover. You can also use FireAMP to create custom protections, block execution of certain applications based on group policy, and create custom whitelists.
 
     [bookmark: pgfId-3382681]Network File Trajectory
 
     [bookmark: pgfId-3400640]The network file trajectory feature allows you to track a file’s transmission path across a network. The system uses SHA-256 hash values to track files; so, to track a file, the system must either:
 
      
      	 [bookmark: pgfId-3417245]calculate the file’s SHA-256 hash value and perform a malware cloud lookup using that value
 
      	 [bookmark: pgfId-3417302]receive endpoint-based threat and quarantine data about that file, using the Defense Center’s integration with your organization’s FireAMP subscription
 
     
 
     [bookmark: pgfId-3415267]Each file has an associated trajectory map, which contains a visual display of the file’s transfers over time as well as additional information about the file.
 
    
 
     
      [bookmark: pgfId-3380420][bookmark: 80259]Application Programming Interfaces
 
     [bookmark: pgfId-3538387]There are several ways to interact with the system using application programming interfaces (APIs). For detailed information, you can download additional documentation from either of the following Support Sites:
 
      
      	 [bookmark: pgfId-3538444] Cisco: ( http://www.cisco.com/cisco/web/support/index.html )
 
     
 
     [bookmark: pgfId-3538395][bookmark: 92691]eStreamer
 
     [bookmark: pgfId-3538403]The Event Streamer (eStreamer) all[bookmark: marker-3538399]ows you to stream several kinds of event data from a Cisco appliance to a custom-developed client application. After you create a client application, you can connect it to an eStreamer server (Defense Center or physical managed device), start the eStreamer service, and begin exchanging data.
 
     [bookmark: pgfId-3380444]eStreamer integration requires custom programming, but allows you to request specific data from an appliance. If, for example, you display network host data within one of your network management applications, you could write a program to retrieve host criticality or vulnerability data from the Defense Center and add that information to your display.
 
     [bookmark: pgfId-3380449]External Database Acc[bookmark: marker-3380448]ess
 
     [bookmark: pgfId-3380450]The database access feature allows you to query several database tables on a Defense Center, using a third-party client that supports JDBC SSL connections.
 
     [bookmark: pgfId-3380460]You can use an industry-standard reporting tool such as Crystal Reports, Actuate BIRT, or JasperSoft iReport to design and submit queries. Or, you can configure your own custom application to query Cisco data. For example, you could build a servlet to report intrusion and discovery event data periodically or refresh an alert dashboard.
 
     [bookmark: pgfId-3380465]Host Inp[bookmark: marker-3380464]ut
 
     [bookmark: pgfId-3380466]The host input feature allows you to augment the information in the network map by importing data from third-party sources using scripts or command-line files. 
 
     [bookmark: pgfId-3380467]The web interface also provides some host input functionality; you can modify operating system or application protocol identities, validate or invalidate vulnerabilities, and delete various items from the network map, including clients and server ports.
 
     [bookmark: pgfId-3380469]Remedia[bookmark: marker-3380468]tion
 
     [bookmark: pgfId-3380470]The system includes an API that allows you to create remediations that your Defense Center can automatically launch when conditions on your network violate an associated correlation policy or compliance white list. This can not only automatically mitigate attacks when you are not immediately available to address them, but can also ensure that your system remains compliant with your organization’s security policy. In addition to remediations that you create, the Defense Center ships with several predefined remediation modules.
 
    
 
   
 
    
     [bookmark: pgfId-3469812][bookmark: 57086]Documentation Reso[bookmark: marker-3469811]urces
 
    [bookmark: pgfId-3469816]The FireSIGHT System documentation set includes online help and PDF files. You can reach the online help from the web interface in the following ways:
 
     
     	 [bookmark: pgfId-1057008]by clicking the context-sensitive help link on each page
 
     	 [bookmark: pgfId-3469837]by selecting  Help > Online 
 
    
 
    [bookmark: pgfId-3533478]The online help includes information about the tasks you can complete using a Defense Center or device’s web interface, including system management, policy management, and event analysis.
 
    [bookmark: pgfId-3533493]You can access the most up-to-date versions of the PDF documentation on either of the following Support Sites:
 
     
     	 [bookmark: pgfId-3533479] Cisco: ( http://www.cisco.com/cisco/web/support/index.html )
 
    
 
    [bookmark: pgfId-3533480]This documentation includes:
 
     
     	 [bookmark: pgfId-3469829]the  FireSIGHT System User Guide , which includes the same content as the online help, but in an easy-to-print format
 
     	 [bookmark: pgfId-1162171]the  FireSIGHT System Installation Guide , which includes information about installing Cisco appliances as well as hardware specifications and safety information
 
     	 [bookmark: pgfId-3402341]the  FireSIGHT System  Virtual Installation Guide , which includes information about installing, managing, and troubleshooting virtual devices and virtual Defense Centers
 
     	 [bookmark: pgfId-3432716]the  Cisco NGIPS for Blue Coat X-Series  Installation and Configuration Guide , which includes information about installing, managing, and troubleshooting Cisco NGIPS for Blue Coat X-Series 
 
     	 [bookmark: pgfId-3533646]various API guides and supplementary material
 
    
 
   
 
    
     [bookmark: pgfId-3533649][bookmark: 57358]Documentation Conventions
 
    [bookmark: pgfId-3312432]This documentation includes information about which FireSIGHT System licenses and appliance models are required for each feature, and which user roles have permission to complete each procedure. For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3256936]License Conventions
 
     	 [bookmark: pgfId-3312949]Supported Device and Defense Center Conventions
 
     	 [bookmark: pgfId-3011264]Access Conventions
 
    
 
     
      [bookmark: pgfId-3256954][bookmark: 29096]License Conve[bookmark: marker-3283623]ntions
 
     [bookmark: pgfId-3313248]The License statement at the beginning of a section indicates the license required to use the feature described in the section, as follows:
 
     [bookmark: pgfId-3391806]FireSIGHT
 
     [bookmark: pgfId-3391813]A FireSIGHT license is included with your Defense Center and is required to perform host, application, and user discovery. The FireSIGHT license on your Defense Center determines how many individual hosts and users you can monitor with the Defense Center and its managed devices, as well as how many users you can use to perform user control. 
 
     [bookmark: pgfId-3391836]Protection
 
     [bookmark: pgfId-3623579]A Protection license allows managed devices to perform intrusion detection and prevention, file control, and Security Intelligence filtering. This license corresponds to the Protection (TA) subscription, which is automatically included in the purchase of any managed device.
 
     [bookmark: pgfId-3623583]Control
 
     [bookmark: pgfId-3623620]A Control license allows managed devices to perform user and application control. It also allows devices to perform switching and routing (including DHCP relay), NAT, and to cluster devices and stacks. A Control license requires a Protection license. This license is included automatically when you purchase any managed device. 
 
     [bookmark: pgfId-3623630]URL Filtering
 
     [bookmark: pgfId-3391857]A URL Filtering license allows managed devices to use regularly updated cloud-based category and reputation data to determine which traffic can traverse your network, based on the URLs requested by monitored hosts. A URL Filtering license requires a Protection license. You can purchase this license as a service subscription combined with Protection (TAC or TAMC) or as an add-on subscription (URL) for a device where Protection (TA) is already enabled.
 
     [bookmark: pgfId-3391868]Malware
 
     [bookmark: pgfId-3391872]A Malware license allows managed devices to perform network-based advanced malware protection (AMP), that is, to detect, capture, and block malware in files transmitted over your network and to submit those files for dynamic analysis. It also allows you to view trajectories, which track files transmitted over your network. A Malware license requires a Protection license. You can purchase the Malware license as a service subscription combined with Protection (TAM or TAMC) or as an add-on subscription (AMP) for a device where Protection (TA) is already enabled.
 
     [bookmark: pgfId-3391880]VPN
 
     [bookmark: pgfId-3623702]A VPN license allows you to build secure VPN tunnels between the virtual routers of Cisco managed devices. A VPN license requires Protection and Control licenses. To purchase a VPN license, contact Sales.
 
     [bookmark: pgfId-3623712]Because licensed capabilities are often additive, this documentation only provides the highest required license for each feature. For example, if a feature requires FireSIGHT, Protection, and Control licenses, only Control is listed. 
 
     [bookmark: pgfId-3337906]An “or” statement in a License statement indicates that a particular license is required to use the feature described in the section, but an additional license can add functionality. For example, within a file policy, some file rule actions require a Protection license while others require a Malware license. So, the License statement for the documentation on file rules lists “Protection or Malware.”
 
     [bookmark: pgfId-3392182]Note that because of architecture and resource limitations, not all licenses can be applied to all managed devices. In general, you cannot license a capability that a device does not support; see Summary of Supported Capabilities by Managed Device Model. For more information, see Understanding Licensing.
 
    
 
     
      [bookmark: pgfId-3312467][bookmark: 78980]Supported Device and Defense Center Conventions
 
     [bookmark: pgfId-3402136]The Supported Devices statement at the beginning of a section indicates that a feature is supported only on the specified device series, family, or model. For example, stacking is only supported on Series 3 devices. If a section does not have a Supported Devices statement, the feature is supported on all devices, or the section does not apply to managed devices. 
 
     [bookmark: pgfId-3417544]For more information on platforms supported by this release, see Introduction to the Defense Center.
 
    
 
     
      [bookmark: pgfId-3402145][bookmark: 87105]Access Conve[bookmark: marker-3402144]ntions
 
      
       
        
        [bookmark: pgfId-3282273]Table 1-7 Access Conventions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3282277]Access Term 
          
  
         	 
           
           [bookmark: pgfId-3282279]Indicates 
          
  
        
 
         
         	[bookmark: pgfId-3282281][bookmark: marker-3283633]Access Admin
  
         	[bookmark: pgfId-3282283]User must have the Access Control Admin role
  
        
 
         
         	[bookmark: pgfId-3282285][bookmark: marker-3315315]Admin
  
         	[bookmark: pgfId-3282287]User must have the Administrator role
  
        
 
         
         	[bookmark: pgfId-3282289]Any
  
         	[bookmark: pgfId-3282291]User can have any role
  
        
 
         
         	[bookmark: pgfId-3286351]Any/Admin
  
         	[bookmark: pgfId-3286353]User can have any role, but only the Administrator role has unrestricted access (such as the ability to view other users’ data saved as private)
  
        
 
         
         	[bookmark: pgfId-3283848]Any Security Analyst
  
         	[bookmark: pgfId-3283850]User can have either the Security Analyst or Security Analyst (Read Only) role
  
        
 
         
         	[bookmark: pgfId-3282293][bookmark: marker-3315310]Database
  
         	[bookmark: pgfId-3282295]User must have the External Database role
  
        
 
         
         	[bookmark: pgfId-3282297][bookmark: marker-3283638]Discovery Admin
  
         	[bookmark: pgfId-3282299]User must have the Discovery Admin role
  
        
 
         
         	[bookmark: pgfId-3282301][bookmark: marker-3283643]Intrusion Admin
  
         	[bookmark: pgfId-3282303]User must have the Intrusion Admin role
  
        
 
         
         	[bookmark: pgfId-3282305][bookmark: marker-3283648]Maint
  
         	[bookmark: pgfId-3282307]User must have the Maintenance User role
  
        
 
         
         	[bookmark: pgfId-3282347][bookmark: marker-3283653]Network Admin
  
         	[bookmark: pgfId-3282349]User must have the Network Admin role
  
        
 
         
         	[bookmark: pgfId-3282309][bookmark: marker-3283658]Security Analyst
  
         	[bookmark: pgfId-3282311]User must have the Security Analyst role
  
        
 
         
         	[bookmark: pgfId-3282313][bookmark: marker-3283663]Security Approver
  
         	[bookmark: pgfId-3282315]User must have the Security Approver role
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3315459]Users with custom roles may have permission sets that differ from those of the predefined roles. When a predefined role is used to indicate access requirements for a procedure, a custom role with similar permissions also has access. Some users with custom roles may use slightly different menu paths to reach configuration pages. For example, users who have a custom role with only intrusion policy privileges access the network analysis policy via the intrusion policy instead of the standard path through the access control policy. For more information on custom user roles, see Managing Custom User Roles.
 
    
 
   
 
    
     [bookmark: pgfId-3315385][bookmark: 65605]IP Address Conventi[bookmark: marker-3315384]ons
 
    [bookmark: pgfId-3288307]You can use IPv4 Classless Inter-Domain Routing (CIDR) notation and the similar IPv6 prefix length notation to define address blocks in many places in the FireSIGHT System.
 
    [bookmark: pgfId-3288311]CIDR notation uses a network IP address combined with a bit mask to define the IP addresses in the specified block of addresses. For example, the following table lists the private IPv4 address spaces in CIDR notation.
 
    [bookmark: pgfId-2935293]
 
     
      
       
       [bookmark: pgfId-2941102]Table 1-8 [bookmark: 10268]CIDR Notation Syntax Examples 
 
       
       
        
        	 
          
          [bookmark: pgfId-2941110]CIDR Block 
         
  
        	 
          
          [bookmark: pgfId-2941112]IP Addresses in CIDR Block 
         
  
        	 
          
          [bookmark: pgfId-2941114]Subnet Mask 
         
  
        	 
          
          [bookmark: pgfId-2941116]Number of IP Addresses 
         
  
       
 
        
        	[bookmark: pgfId-2941118]10.0.0.0/8
  
        	[bookmark: pgfId-2941120]10.0.0.0 - 10.255.255.255
  
        	[bookmark: pgfId-2941122]255.0.0.0
  
        	[bookmark: pgfId-2941124]16,777,216
  
       
 
        
        	[bookmark: pgfId-2941126]172.16.0.0/12
  
        	[bookmark: pgfId-2941128]172.16.0.0 - 172.31.255.255
  
        	[bookmark: pgfId-2941130]255.240.0.0
  
        	[bookmark: pgfId-2941132]1,048,576
  
       
 
        
        	[bookmark: pgfId-2941134]192.168.0.0/16
  
        	[bookmark: pgfId-2941136]192.168.0.0 - 192.168.255.255
  
        	[bookmark: pgfId-2941138]255.255.0.0
  
        	[bookmark: pgfId-2941140]65,536
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2935220]Similarly, IPv6 uses a network IP address combined with a prefix length to define the IP addresses in a specified block. For example, 2001:db8::/32 specifies the IPv6 addresses in the 2001:db8:: network with a prefix length of 32 bits, that is, 2001:db8:: through 2001:db8:ffff:ffff:ffff:ffff:ffff:ffff.
 
    [bookmark: pgfId-3288510]When you use CIDR or prefix length notation to specify a block of IP addresses, the FireSIGHT System uses only the portion of the network IP address specified by the mask or prefix length. For example, if you type 10.1.2.3/8, the FireSIGHT System uses 10.0.0.0/8.
 
    [bookmark: pgfId-2935228]In other words, although Cisco recommends the standard method of using a network IP address on the bit boundary when using CIDR or prefix length notation, the FireSIGHT System does not require it.
 
    [bookmark: pgfId-2660514]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3513769]Logging into the FireSIGHT System 
      
      
 
     
 
 
    [bookmark: pgfId-3426947]This chapter details the steps you must take to log into and log out of the FireSIGHT System, using the appliance-based web interface as well as the command line interface (CLI). You can also configure externally authenticated user accounts that use LDAP or RADIUS credentials.
 
    [bookmark: pgfId-3515259]After you have logged into the web interface, the context menu feature provides extra information and helpful navigation links when you hover your pointer over certain areas.
 
    [bookmark: pgfId-3514813]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3514761]Logging into the Appliance
 
     	 [bookmark: pgfId-3514799]Logging Out of the Appliance
 
     	 [bookmark: pgfId-3514804]Using the Context Menu
 
    
 
   
 
    
     [bookmark: pgfId-3380711][bookmark: 96826]Loggi[bookmark: marker-3380709]ng into the Appliance
 
    [bookmark: pgfId-3527852]License: Any
 
    [bookmark: pgfId-3527860]The FireSIGHT System Defense Center has a web interface that you can use to perform administrative, management, and analysis tasks. Physical managed devices also have a web interface that you can use to perform initial setup and basic analysis and configuration tasks. For information on browser requirements, refer to the release notes for this version of the FireSIGHT System.
 
    [bookmark: pgfId-3503520]Virtual managed devices do not have web interfaces. For these devices (and Series 3 devices as well), the FireSIGHT System provides an interactive CLI that you can use to perform any tasks that you cannot complete using the device’s managing Defense Center.
 
    [bookmark: pgfId-3504275]Cisco NGIPS for Blue Coat X-Series also does not have a web interface. However, it has a CLI unique to the X-Series platform. You use this CLI to install the system and to perform other platform-specific administrative tasks. For more information, including how to log in to the X-Series platform CLI, see the Cisco NGIPS for Blue Coat X-Series Installation and Configuration Guide.
 
    [bookmark: pgfId-3536891]ASA FirePOWER devices have their own management applications (ASDM and CSM) and CLI for configuring the ASA device. In addition, the FireSIGHT System provides an interactive CLI that you can use to perform any tasks that you cannot complete using the device’s managing Defense Center. You use the ASA-specific tools to install the system and to perform other platform-specific administrative tasks. See the ASA documentation for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-3518409]Note Because FirePOWER appliances audit user activity based on user accounts, make sure that users log into the system with the correct account.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3503227]You must provide a username and password to obtain access to the web interface, CLI, or shell of an appliance. After you log into an appliance, the features you can access are controlled by the privileges granted to your user account. For more information, see Managing User Accounts.
 
    [bookmark: pgfId-3531038]Optionally, if your organization uses Common Access Cards (CACs) for authentication, you can use your CAC credentials to obtain access to the web interface of an appliance. For more information about CAC authentication and authorization, see Understanding LDAP Authentication With CAC.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-3380734] 
     Caution If you supply incorrect credentials multiple times, your shell access account may be locked. If you supply correct credentials and the login is refused, contact your system administrator rather than repeatedly attempting to log in. 
      
      
 
     
 
    
 
    [bookmark: pgfId-3381298]Th[bookmark: marker-3381323]e first time you visit the appliance home page during a web session, you can view information about your last login session for that appliance. You can see the following information about your last login:
 
     
     	 [bookmark: pgfId-3381299]the day of the week, month, date, and year of the login
 
     	 [bookmark: pgfId-3381300]the appliance-local time of the login in 24-hour notation
 
     	 [bookmark: pgfId-3381301]the host and domain name last used to access the appliance
 
    
 
    [bookmark: pgfId-3380736]By default, your [bookmark: marker-3380735]session automatically logs you out after 1 hour of inactivity, unless you are otherwise configured to be exempt from session timeout. Users with the Administrator role can change the session timeout interval in the system policy. For more information, see Managing User Login Settings and Configuring User Interface Settings.
 
    [bookmark: pgfId-3380743]Note that some processes that take a significant amount of time may cause your web browser to display a message that a script has become unresponsive. If this occurs, make sure you allow the script to continue until it finishes.
 
     
      
    
 
    
 
    [bookmark: pgfId-3503346]Note For fresh installations (new or reimaged) of the system on an appliance, you must log in using the administrative (admin) user account to complete the initial setup process, which is described in the FireSIGHT System Installation Guide. After you create other user accounts as described in Adding New User Accounts, you and other users should use those accounts to log in to the web interface.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-3531046]Tip You must configure CAC authentication and authorization before users on your network can log in to the CAC Login page using their CAC credentials. For more information, see Understanding LDAP Authentication With CAC.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3380744]To log into the appliance via the web interface:
 
    [bookmark: pgfId-3380745]Access: Any
 
    
 
    [bookmark: pgfId-3380746]Step 1 Direct your browser to https://hostname/, where hostname corresponds to the host name of the appliance.
 
    [bookmark: pgfId-3380747]The Login page appears.
 
    [bookmark: pgfId-3380748]Step 2 In the Username and Password fields, type your user name and password. User names are case sensitive.
 
    [bookmark: pgfId-3515769]If your organization uses [bookmark: marker-3515768]SecurID tokens when logging in, append the token to your SecurID PIN and use that as your password to log in. For example, if your PIN is 1111 and the SecurID token is 222222, type 1111222222. You must have already generated your SecurID PIN before you can log into the FireSIGHT System.
 
    [bookmark: pgfId-3515773]Step 3 Click Login.
 
    [bookmark: pgfId-3380754]The default start page appears. If you selected a custom home page for your user account, that page is displayed instead. See Specifying Your Home Page for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-3531054]Tip If you do not have access to the web interface, contact your system administrator to modify your account privileges, or log in as a user with Administrator access and modify the privileges for the account. For more information, see Modifying User Privileges and Options.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3524828]The menus and menu options listed at the top of the page are based on the privileges for your user account. However, the links on the default home page include options that span the range of user account privileges. I[bookmark: marker-3524829]f you click a link that requires different privileges from those granted to your account, the following warning message is displayed:
 
     
     [bookmark: pgfId-3524830]You are attempting to view an unauthorized page. This activity has been logged. 
    
 
    [bookmark: pgfId-3440160]You can either select a different option from the available menus or click Back in your browser window to return to the previous page.
 
    [bookmark: pgfId-3524441]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3531067]To log into the appliance via the web interface using CAC credentials:
 
    [bookmark: pgfId-3531071]Access: Any
 
    
 
    [bookmark: pgfId-3531073]Step 1 [bookmark: 66048]Insert a CAC as instructed by your organization.
 
    [bookmark: pgfId-3531074]Step 2 Direct your browser to https://hostname/, where hostname corresponds to the host name of the appliance.
 
    [bookmark: pgfId-3531078]Step 3 If prompted, enter the PIN associated with the CAC you inserted in step 1.
 
    [bookmark: pgfId-3532782]Your PIN is accepted.
 
    [bookmark: pgfId-3532783]Step 4 If prompted, select the appropriate certificate from the drop-down list.
 
    [bookmark: pgfId-3532784]The browser accepts your selection and the CAC Login page appears.
 
    [bookmark: pgfId-3531082]Step 5 To authenticate using your CAC credentials, click Continue.
 
    [bookmark: pgfId-3531083]To authenticate using your user name and password, enter them in the Username and Password fields. User names are case sensitive.
 
    [bookmark: pgfId-3531084]The default start page appears. If you selected a custom home page for your user account, that page is displayed instead. See Specifying Your Home Page for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-3531088]Tip If you do not have access to the web interface, contact your system administrator to modify your account privileges, or log in as a user with Administrator access and modify the privileges for the account. For more information, see Modifying User Privileges and Options.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3531092]The menus and menu options listed at the top of the page are based on the privileges for your user account. However, the links on the default home page include options that span the range of user account privileges. I[bookmark: marker-3531093]f you click a link that requires different privileges from those granted to your account, the following warning message is displayed:
 
     
     [bookmark: pgfId-3531094]You are attempting to view an unauthorized page. This activity has been logged. 
    
 
    [bookmark: pgfId-3531818]You can either select a different option from the available menus or click Back in your browser window to return to the previous page.
 
     
      
    
 
    
 
    [bookmark: pgfId-3531819]Note Do not remove a CAC during an active browsing session. If you remove or replace a CAC during a session, your web browser terminates the session and the system logs you out of the web interface.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3531097]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3440164]To log into a Series 3, virtual, or ASA FirePOWER device via the command line:
 
    [bookmark: pgfId-3440165]Access: CLI Basic Configuration
 
    
 
    [bookmark: pgfId-3380767]Step 1 For Series 3 and virtual devices, open an SSH connection to the appliance at hostname, where hostname corresponds to the host name of the appliance. For ASA FirePOWER devices, open the SSH connection to the ASA FirePOWER module at the management address.
 
    [bookmark: pgfId-3380768]The login as: command prompt appears.
 
    [bookmark: pgfId-3380769]Step 2 Type your user name and press Enter. 
 
    [bookmark: pgfId-3380770]The Password: prompt appears.
 
    [bookmark: pgfId-3503311]Step 3 Type your password and press Enter.
 
    [bookmark: pgfId-3505087]If your organization uses [bookmark: marker-3505086]SecurID tokens when logging in, append the token to your SecurID PIN and use that as your password to log in. For example, if your PIN is 1111 and the SecurID token is 222222, type 1111222222. You must have already generated your SecurID PIN before you can log into the FireSIGHT System.
 
    [bookmark: pgfId-3503334]The login banner appears, followed by the > prompt.
 
    [bookmark: pgfId-3503313]You can use any of the commands allowed by your level of command line access. See the Command Line Reference for more information on available CLI commands.
 
    [bookmark: pgfId-3522915]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3380818][bookmark: 31911][bookmark: 62905]Logging [bookmark: marker-3380817]Out of the Appliance
 
    [bookmark: pgfId-3380819]License: Any
 
    [bookmark: pgfId-3380823]When you are no longer actively using the web interface, Cisco recommends that you log out, even if you are only stepping away from your web browser for a short period of time. Logging out ends your web session and ensures that no one can use the appliance with your credentials.
 
    [bookmark: pgfId-3380825]By default, your [bookmark: marker-3380824]session automatically logs you out after 1 hour of inactivity, unless you are otherwise configured to be exempt from session timeout. Users with the Administrator role can change the session timeout interval in the system policy. For more information, see Managing User Login Settings and Configuring User Interface Settings.
 
    [bookmark: pgfId-3380832]To log out of the appliance:
 
    [bookmark: pgfId-3380833]Access: Any
 
    
 
    [bookmark: pgfId-3380835]Step 1 [bookmark: 69597]Click Logout on the toolbar.
 
    [bookmark: pgfId-3524488]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3380846][bookmark: 92935]Using the Cont[bookmark: marker-3380845]ext Menu
 
    [bookmark: pgfId-3419817]License: feature dependent
 
    [bookmark: pgfId-3419819]For your convenience, certain pages in the web interface support a pop-up context menu that you can use as a shortcut for accessing other features in the FireSIGHT System. The contents of the menu depend on the hotspot where you access it—not only the page but also the specific data. 
 
    [bookmark: pgfId-3420134]For example, IP address hotspots in event views, intrusion event packet views, the dashboard, and the Context Explorer provide additional options. Use the IP address context menu by right-clicking on the hotspot to learn more about the host associated with that address, including any available whois and host profile information. Except on the DC500 Defense Center, which does not support Security Intelligence filtering, you can also add an individual IP address to the Security Intelligence global whitelist or blacklist.
 
    [bookmark: pgfId-3419657]As another example, SHA-256 value hotspots in event views and the dashboard allow you to add a file’s SHA-256 hash value to the clean list or custom detection list, or view the entire hash value for copying. Note that this functionality is also not supported on the DC500 Defense Center.
 
    [bookmark: pgfId-3380852]The following list describes many of the options available in the context menu on various pages of the web interface. On pages or locations where the Cisco context menu is not supported, the normal context menu for your browser appears. 
 
    [bookmark: pgfId-3380856]Access Control, SSL, and NAT Policy Editors
 
    [bookmark: pgfId-3380857]The access control, SSL, and NAT policy editors contain hotspots over each rule. You can use the context menu to insert new rules and categories; cut, copy, and paste rules; set the rule state; and edit the rule.
 
    [bookmark: pgfId-3380860]Intrusion Rule Editor
 
    [bookmark: pgfId-3380861]The intrusion rule editor contains hotspots over each intrusion rule. You can use the context menu to edit the rule, set the rule state (including disabling the rule), configure thresholding and suppression options, and view rule documentation.
 
    [bookmark: pgfId-3380862]Event Viewer
 
    [bookmark: pgfId-3380863]Event pages (drill-down pages and table views) contain hotspots over each event, IP address, and certain detected files’ SHA-256 hash values. For most event types, you can use the context menu to view related information in the Context Explorer, or drill down into event information in a new window. In places where an event field contains text too long to fully display in the event view, such as a file’s SHA-256 hash value, a vulnerability description, or a URL, you can use the context menu to view the full text. 
 
    [bookmark: pgfId-3431242]For captured files, file events, and malware events, you can use the context menu to add a file to or remove a file from the clean list or custom detection list, download a copy of the file, view nested files inside an archive file, download the parent archive file for a nested file, or submit the file to the Collective Security Intelligence Cloud for dynamic analysis.
 
    [bookmark: pgfId-3417792]For intrusion events, you can use the context menu to perform similar tasks to those in the intrusion rule editor or an intrusion policy: edit the triggering rule, set the rule state (including disabling the rule), configure thresholding and suppression options, and view rule documentation.
 
    [bookmark: pgfId-3380865]Packet View
 
    [bookmark: pgfId-3380866]Intrusion event packet views contain IP address hotspots. Note that the packet view uses a left-click context menu instead of a right-click menu.
 
    [bookmark: pgfId-3380867]Dashboard
 
    [bookmark: pgfId-3380868]Many dashboard widgets contain hotspots to view related information in the Context Explorer. Dashboard widgets can also contain IP address and SHA-256 value hotspots. 
 
    [bookmark: pgfId-3380870]Context Explor[bookmark: marker-3380869]er
 
    [bookmark: pgfId-3419039]The Context Explorer contains hotspots over its charts, tables, and graphs. If you want to examine data from graphs or lists in more detail than the Context Explorer allows, you can drill down to the table views of the relevant data. You can also view related host, user, application, file, and intrusion rule information.
 
    [bookmark: pgfId-3419074]Note that the Context Explorer uses a left-click context menu, which also contains filtering and other options unique to the Context Explorer. For detailed information, see Drilling Down on Context Explorer Data.
 
    [bookmark: pgfId-3380881]To access the context menu:
 
    [bookmark: pgfId-3380882]Access: Any
 
    
 
    [bookmark: pgfId-3380883]Step 1 On a hotspot-enabled page in the web interface, hover your pointer over a hotspot.
 
    [bookmark: pgfId-3380884]Except in the Context Explorer, a Right-click for menu message appears.
 
    [bookmark: pgfId-3380885]Step 2 Invoke the context menu:
 
     
      
      	 [bookmark: pgfId-3380886]In the Context Explorer or packet view, left-click your pointing device.
 
      	 [bookmark: pgfId-3380887]On all other hotspot-enabled pages, right-click your pointing device.
 
     
 
    
 
    [bookmark: pgfId-3380888]A pop-up context menu appears with options appropriate for the hotspot.
 
    [bookmark: pgfId-3380889]Step 3 Select one of the options by left-clicking the name of the option.
 
    [bookmark: pgfId-3380890]If you are using the access control policy editor or NAT policy editor, the rule is modified. Otherwise, a new browser window opens based on the option you selected.
 
    [bookmark: pgfId-3524503]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2660514]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7965447][bookmark: 17304]Managing Reusable Ob[bookmark: marker-7965445]jects 
      
      
 
     
 
 
    [bookmark: pgfId-7889016]For increased flexibility and web interface ease-of-use, the FireSIGHT System allows you to create named objects, which are reusable configurations that associate a name with a value so that when you want to use that value, you can use the named object instead.
 
    [bookmark: pgfId-8059418]You can create the following types of objects:
 
     
     	 [bookmark: pgfId-8059419]network-based objects that represent IP addresses and networks, port/protocol pairs, VLAN tags, security zones, and origin/destination country (geolocation) 
 
     	 [bookmark: pgfId-8131334]reputation-based objects that represent Security intelligence feeds and lists, application filters based on category and reputation, and file lists 
 
     	 [bookmark: pgfId-8131527]non-reputation-based objects such as URL categories
 
     	 [bookmark: pgfId-8131557]intrusion policy variable sets that contain variables you associate with an intrusion policy
 
     	 [bookmark: pgfId-8059421]objects that help you handle encrypted traffic, including cipher suites, public key certificates and paired private keys, and certificate distinguished names
 
    
 
    [bookmark: pgfId-7941981]You can use these objects in various places in the system’s web interface, including access control policies, network analysis policies, intrusion policies and rules, network discovery rules, event searches, reports, dashboards, and so on.
 
    [bookmark: pgfId-8068569]Grouping objects allows you to reference multiple objects with a single configuration. You can group network, port, VLAN tag, URL, and public key infrastructure (PKI) objects.
 
     
      
    
 
    
 
    [bookmark: pgfId-7618623]Note In most cases, editing an object used in a policy requires a policy reapply for your changes to take effect. Editing a security zone also requires that you reapply the appropriate device configurations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7618624]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-7618628]Using the Object Manager
 
     	 [bookmark: pgfId-7618632]Working with Network Objects
 
     	 [bookmark: pgfId-7618636]Working with Security Intelligence Lists and Feeds
 
     	 [bookmark: pgfId-7618640]Working with Port Objects
 
     	 [bookmark: pgfId-7618644]Working with VLAN Tag Objects
 
     	 [bookmark: pgfId-7618648]Working with URL Objects
 
     	 [bookmark: pgfId-7618652]Working with Application Filters
 
     	 [bookmark: pgfId-7618656]Working with Variable Sets
 
     	 [bookmark: pgfId-7618660]Working with File Lists
 
     	 [bookmark: pgfId-7618664]Working with Security Zones
 
     	 [bookmark: pgfId-8059465]Working with Cipher Suite Lists
 
     	 [bookmark: pgfId-8059469]Working with Distinguished Name Objects
 
     	 [bookmark: pgfId-8059473]Working with PKI Objects
 
     	 [bookmark: pgfId-7618668]Working with Geolocation Objects
 
    
 
   
 
    
     [bookmark: pgfId-7618671][bookmark: 12440]Using the Object Mana[bookmark: marker-7618670]ger
 
    [bookmark: pgfId-7618672]License: Any
 
    [bookmark: pgfId-7618673]Create and manage objects, including application filters, variable sets, and security zones, using the object manager (Objects > Object Management). You can group network, port, VLAN tag, URL, and PKI objects; you can also sort, filter, and browse the list of objects and object groups.
 
    [bookmark: pgfId-7618679]For more information, see:
 
     
     	 [bookmark: pgfId-7618683]Grouping Objects
 
     	 [bookmark: pgfId-7618687]Browsing, Sorting, and Filtering Objects
 
    
 
     
      [bookmark: pgfId-7618694][bookmark: 94397]Grouping Obj[bookmark: marker-7618692]ects
 
     [bookmark: pgfId-7618695]License: Any
 
     [bookmark: pgfId-7618700]You can group network, port, VLAN tag, URL, and PKI objects. The system allows you to use objects and object groups interchangeably in the web interface. For example, anywhere you would use a port object, you can also use a port object group. Objects and object groups of the same type cannot have the same name.
 
      
       
     
 
     
 
     [bookmark: pgfId-8059514]Tip To group cipher suites, configure a cipher suite list. For more information, see Working with Cipher Suite Lists. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7934983]When you edit an object group used in a policy (for example, a network object group used in an access control policy), you must reapply the policy for your changes to take effect.
 
     [bookmark: pgfId-7618702]Deleting a group does not delete the objects in the group, just their association with each other. Additionally, you cannot delete a group that is in use. For example, you cannot delete a VLAN tag group that you are using in a VLAN condition in a saved access control policy.
 
     [bookmark: pgfId-7618703]To group reusable objects:
 
     [bookmark: pgfId-7618704]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-7618705]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-7618706]The Object Management page appears.
 
     [bookmark: pgfId-8059540]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8059541]Under the type of  Network ,  Port ,  VLAN Tag ,  URL , or  Distinguished Name object you want to group, select  Object Groups .
 
       	 [bookmark: pgfId-8059542]Under  PKI , select  Internal CA Groups ,  Trusted CA Groups ,  Internal Cert Groups , or  External Cert Groups for the type of PKI object you want to group.
 
      
 
     
 
     [bookmark: pgfId-7618708]The page for the type of object you are grouping appears.
 
     [bookmark: pgfId-8059560]Step 3 Click the Add button that corresponds with the object you want to group. 
 
     [bookmark: pgfId-7618710]A pop-up window appears where you can create the group.
 
     [bookmark: pgfId-7618715]Step 4 Type a Name for the group. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-7618716]Step 5 Select one or more objects and click Add.
 
      
       
       	 [bookmark: pgfId-8140435]Use Shift and Ctrl to select multiple objects, or right-click and  Select All . 
 
       	 [bookmark: pgfId-8140439]Use the filter field 
 
      
 
      [image: ] to search for existing objects to include, which updates as you type to display matching items. Click the reload icon 
      [image: ] above the search field or click the clear icon ( 
      [image: ] ) in the search field to clear the search string. 
     
 
      
       
       	 [bookmark: pgfId-7618731]Click the add icon [
 
      
 
      [image: ] ] to create objects on the fly if no existing objects meet your needs. 
     
 
     [bookmark: pgfId-7618732]Step 6 Click Save.
 
     [bookmark: pgfId-7618733]The group is created.
 
     [bookmark: pgfId-7994436]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7618736][bookmark: 20396]Browsing, Sorting, and F[bookmark: marker-7618735]iltering Objects
 
     [bookmark: pgfId-7618737]License: Any
 ) to refresh your view. 
     
 ) arrow next to a column heading indicates that the page is sorted by that column in that direction. You can also filter the objects on the page by name. For some object types, the same filter will match on either the name or the value. 
     
 
     [bookmark: pgfId-7618753]To sort objects or groups:
 
     [bookmark: pgfId-7618754]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-7618755]Step 1 Click a column heading. To sort in the opposite direction, click the heading again.
 
     [bookmark: pgfId-7994486]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7618756]To filter objects or groups:
 
     [bookmark: pgfId-7618757]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-7618758]Step 1 Type your filter criteria in the Filter field.
 
     [bookmark: pgfId-7618759]The page updates as you type to display matching items. You can use the following metacharacters:
 
      
       
       	 [bookmark: pgfId-8122207]The asterisk [ * ] matches zero or more occurrences of a character.
 
       	 [bookmark: pgfId-8122407]The caret ( ^ ) matches content at the beginning of a string.
 
       	 [bookmark: pgfId-8122520]The dollar sign ( $ ) matches content at the end of a string.
 
      
 
     
 
     [bookmark: pgfId-7994502]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7618763][bookmark: 30722]Working with Network [bookmark: marker-7618761]Objects
 
    [bookmark: pgfId-7618764]License: Any
 
    [bookmark: pgfId-7618766]A network object represents one or more IP addresses that you can specify either individually or as address blocks. You can use network objects and groups (see Grouping Objects) in various places in the system’s web interface, including access control policies, network variables, intrusion rules, network discovery rules, event searches, reports, and so on.
 
    [bookmark: pgfId-7618771]You also cannot delete a network object that is in use. Additionally, after you edit a network object used in an access control, network discovery, or intrusion policy, you must reapply the policy for your changes to take effect.
 
    [bookmark: pgfId-7618772]To create a network object:
 
    [bookmark: pgfId-7618773]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-7618774]Step 1 Select Objects > Object Management.
 
    [bookmark: pgfId-7618775]The Object Management page appears.
 
    [bookmark: pgfId-7618776]Step 2 Under Network, select Individual Objects.
 
    [bookmark: pgfId-7618777]Step 3 Click Add Network.
 
    [bookmark: pgfId-7618778]The Network Objects pop-up window appears.
 
    [bookmark: pgfId-7618783]Step 4 Type a Name for the network object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-7618784]Step 5 For each IP address or address block you want to add to the network object, type its value and click Add.
 
    [bookmark: pgfId-7618785]Step 6 Click Save.
 
    [bookmark: pgfId-7618786]The network object is added.
 
    [bookmark: pgfId-7994540]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7618790][bookmark: 30903]Working with Security Int[bookmark: marker-7618788]elligence Lists and Feeds
 
    [bookmark: pgfId-8107910]License: Protection
 
    [bookmark: pgfId-8107914]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-8107921]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-7618804]The Security Intelligence feature allows you to, per access control policy, specify the traffic that can traverse your network based on the source or destination IP address. This is especially useful if you want to blacklist — deny traffic to and from — specific IP addresses, before the traffic is subjected to analysis by access control rules. Similarly, you can add IP addresses to the whitelist to force the system to handle their connections using access control.
 
    [bookmark: pgfId-7618805]If you are not sure whether you want to blacklist a particular IP address, you can use a “monitor-only” setting, which allows the system to handle the connection using access control, but also logs the connection’s match to the blacklist.
 
    [bookmark: pgfId-7618807]A [bookmark: marker-7618806]global whitelist and global blacklist are included by default in every access control policy, and apply to any zone. Additionally, within each access control policy, you can build a separate whitelist and blacklist using a combination of network objects and groups as well as Security Intelligence lists and feeds, all of which you can constrain by security zone.
 
     
      
    
 
    
 
    [bookmark: pgfId-7618811]Note Although they have all other Protection capabilities by default, Series 2 devices cannot perform Security Intelligence filtering.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7618815]Comparing Feeds and Lists
 
    [bookmark: pgfId-8105549]A Security Intelligence feed is a dynamic collection of IP addresses that the Defense Center downloads from an HTTP or HTTPS server at the interval you configure. Because feeds are regularly updated, the system can use up-to-date information to filter your network traffic. To help you build blacklists, Cisco provides the Intelligence Feed (sometimes called the Sourcefire Intelligence Feed), which represents IP addresses determined by the Cisco VRT to have a poor reputation. 
 
    [bookmark: pgfId-7618832]When the Defense Center downloads updated feed information, it automatically updates its managed devices. Although it may take a few minutes for a feed update to take effect throughout your deployment, you do not have to reapply access control policies after you create or modify a feed, or after a scheduled feed update. 
 
     
      
    
 
    
 
    [bookmark: pgfId-7618836]Note If you want strict control over when the Defense Center downloads a feed from the Internet, you can disable automatic updates for that feed. However, Cisco recommends that you allow automatic updates. Although you can manually perform on-demand updates, allowing the system to download feeds on a regular basis provides you with the most up-to-date, relevant data.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7618840]A Security Intelligence list, contrasted with a feed, is a simple static list of IP addresses that you manually upload to the Defense Center. Use custom lists to augment and fine-tune feeds and the global whitelist and blacklist. Note that editing custom lists (as well as editing network objects and removing IP addresses from the global whitelist or blacklist) require an access control policy apply for your changes to take effect.
 
    [bookmark: pgfId-7618844]Formatting and Corrupt Feed Data
 
    [bookmark: pgfId-7618845]Feed and list source must be a simple text file no larger than 500MB, with one IP address or address block per line. Comment lines must start with the # character. List source files must use the .txt extension.
 
    [bookmark: pgfId-7618849]If the Defense Center downloads a corrupt feed or a feed with no recognizable IP addresses, the system continues using the old feed data (unless it is the first download). However, if the system can recognize even one IP address in the feed, the Defense Center updates its managed devices with the addresses it can recognize.
 
    [bookmark: pgfId-7618853]The default health policy includes the Security Intelligence module, which alerts in a few situations involving Security Intelligence filtering, including if the Defense Center cannot update a feed, or if a feed is corrupt or contains no recognizable IP addresses.
 
    [bookmark: pgfId-7618858]Internet Ac[bookmark: marker-7618857]cess and High Availability
 
    [bookmark: pgfId-7618862]The system uses port 443/HTTPS to download the Intelligence Feed, and either 443/HTTP or 80/HTTP to download custom or third-party feeds. To update feeds, you must open the appropriate port, both inbound and outbound, on the Defense Center. If your Defense Center does not have direct access to the feed site, it can use a proxy server (see Configuring Management Interfaces).
 
     
      
    
 
    
 
    [bookmark: pgfId-7618875]Note The Defense Center does not perform peer SSL certificate verification when downloading custom feeds, nor does the system support the use of certificate bundles or self-signed certificates to verify the remote peer.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7618878]Although Security Intelligence objects are synchronized between Defense Centers in a high availability deployment, only the primary Defense Center downloads feed updates. If the primary Defense Center fails, you must not only make sure that the secondary Defense Center has access to the feed sites, but also use the web interface on the secondary Defense Center to promote it to Active. For more information, see Monitoring and Changing High Availability Status.
 
    [bookmark: pgfId-7618895]Managing Feeds and Lists
 
    [bookmark: pgfId-7618896]You create and manage Security Intelligence lists and feeds, collectively called Security Intelligence objects, using the object manager’s Security Intelligence page. (For information on creating and managing network objects and groups, see Working with Network Objects.)
 
    [bookmark: pgfId-7618904]Note that you cannot delete a custom list or feed that is currently being used in a saved or applied access control policy. You also cannot delete a global list, although you can remove individual IP addresses. Similarly, although you cannot delete the Intelligence Feed, editing it allows you to disable or change the frequency of its updates.
 
    [bookmark: pgfId-7618908]Security Intelligence Object Quick Reference
 
     
      
       
       [bookmark: pgfId-7618916]Table 3-1 [bookmark: 29847]Security Intelligence Object Capabilities 
 
       
       
        
        	 
          
          [bookmark: pgfId-7618928]Capability 
         
  
        	 
          
          [bookmark: pgfId-7618930]Global Whitelist or Blacklist 
         
  
        	 
          
          [bookmark: pgfId-7618932]Intelligence Feed 
         
  
        	 
          
          [bookmark: pgfId-7618934]Custom Feed 
         
  
        	 
          
          [bookmark: pgfId-7618936]Custom List 
         
  
        	 
          
          [bookmark: pgfId-7618938]Network Object 
         
  
       
 
        
        	[bookmark: pgfId-7618940]method of use
  
        	[bookmark: pgfId-7618942]in access control policies by default
  
        	 [bookmark: pgfId-7618944]in any access control policy as either a whitelist or blacklist object
  
       
 
        
        	[bookmark: pgfId-7618952]can be constrained by security zone?
  
        	[bookmark: pgfId-7618954]no
  
        	[bookmark: pgfId-7618956]yes
  
        	[bookmark: pgfId-7618958]yes
  
        	[bookmark: pgfId-7618960]yes
  
        	[bookmark: pgfId-7618962]yes
  
       
 
        
        	[bookmark: pgfId-7618964]can be deleted?
  
        	[bookmark: pgfId-7618966]no
  
        	[bookmark: pgfId-7618968]no
  
        	 [bookmark: pgfId-7618970]yes, unless currently being used in a saved or applied access control policy
  
       
 
        
        	[bookmark: pgfId-7618976]object manager edit capabilities
  
        	[bookmark: pgfId-7618978]delete IP addresses only (add IP addresses using the context menu)
  
        	[bookmark: pgfId-7618980]disable or change update frequency
  
        	[bookmark: pgfId-7618982]fully modify
  
        	[bookmark: pgfId-7618984]upload a modified list only
  
        	[bookmark: pgfId-7618986]fully modify
  
       
 
        
        	[bookmark: pgfId-7618988]requires access policy control reapply when modified?
  
        	[bookmark: pgfId-7618990]yes when deleting (adding IP addresses does not require reapply)
  
        	[bookmark: pgfId-7618992]no
  
        	[bookmark: pgfId-7618994]no
  
        	[bookmark: pgfId-7618996]yes
  
        	[bookmark: pgfId-7618998]yes
  
       
 
       
     
 
    
 
    [bookmark: pgfId-7619000]For more information on creating, managing, and using Security Intelligence lists and feeds, see:
 
     
     	 [bookmark: pgfId-7619004]Working with the Global Whitelist and Blacklist
 
     	 [bookmark: pgfId-7619008]Working with the Intelligence Feed
 
     	 [bookmark: pgfId-7619012]Working with Custom Security Intelligence Feeds
 
     	 [bookmark: pgfId-7619016]Manually Updating Security Intelligence Feeds
 
     	 [bookmark: pgfId-7619020]Working with Custom Security Intelligence Lists
 
     	 [bookmark: pgfId-7619024]Blacklisting Using Security Intelligence IP Address Reputation
 
    
 
     
      [bookmark: pgfId-7619027][bookmark: 80956]Working with the Global W[bookmark: marker-7619026]hitelist and Blacklist
 
     [bookmark: pgfId-7619031]License: Protection
 
     [bookmark: pgfId-8107942]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-7619039]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-7619040]In the course of your analysis, you can build a Security Intelligence global blacklist by using the IP address context menu in an event view, the Context Explorer, or a dashboard. For example, if you notice a set of routable IP addresses in intrusion events associated with exploit attempts, you can immediately blacklist those IP addresses. You can also build a global whitelist in a similar fashion.
 
     [bookmark: pgfId-7619041]The system’s global whitelist and blacklist are included by default in every access control policy, and apply to any zone. You can opt not to use these global lists on a per-policy basis. 
 
     [bookmark: pgfId-7619045]When you add an IP address to a global list, the Defense Center automatically updates its managed devices. Although it may take a few minutes for your changes to take effect throughout your deployment, you do not have to reapply access control policies after adding an IP address to a global list. Conversely, after you delete IP addresses from the global whitelist or blacklist, you must apply your access control policies for your changes to take effect.
 
     [bookmark: pgfId-8138100]Note that although you can add network objects with a netmask of /0 to the whitelist or blacklist, address blocks using a /0 netmask in those objects will be ignored and whitelist and blacklist filtering will not occur based on those addresses. Address blocks with a /0 netmask from Security Intelligence feeds will also be ignored. If you want to monitor or block all traffic targeted by a policy, use an access control rule with the Monitor or Block rule action, respectively, and a default value of any for the Source Networks and Destination Networks, instead of security intelligence filtering.
 
     [bookmark: pgfId-7619047]Because adding an IP address to the global whitelist or blacklist affects access control, you must have one of the following:
 
      
      	 [bookmark: pgfId-7619048]Administrator access
 
      	 [bookmark: pgfId-7619049]a combination of default roles: Network Admin or Access Admin, plus Security Analyst and Security Approver
 
      	 [bookmark: pgfId-7619050]a custom role with both Modify Access Control Policy and Apply Access Control Policy permissions; see Managing Your Deployment with Custom User Roles
 
     
 
     [bookmark: pgfId-7619055]To add an IP address to the global whitelist or blacklist using the co[bookmark: marker-7619054]ntext menu:
 
     [bookmark: pgfId-7619056]Access: Admin/Custom
 
     
 
     [bookmark: pgfId-7619057]Step 1 In an event view, packet view, the Context Explorer, or a dashboard, hover your pointer over an IP address hotspot.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7619062]Step 2 Invoke the context menu:
 
     
      
      	 [bookmark: pgfId-7619063]In an event view or dashboard, right-click.
 
      	 [bookmark: pgfId-7619064]In the Context Explorer or packet view, left-click.
 
     
 
    
 
    [bookmark: pgfId-7619065]Step 3 From the context menu, select either Whitelist Now or Blacklist Now.
 
    [bookmark: pgfId-7619068]For information on the other options in the context menu, see Using the Context Menu.
 
    [bookmark: pgfId-7619070]Step 4 Confirm that you want to whitelist or blacklist the IP address.
 
    [bookmark: pgfId-7619076]After the Defense Center communicates your addition to its managed devices, your deployment begins filtering traffic according to your change.
 
    [bookmark: pgfId-7994556]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7619077]To remove IP addresses from the global whitelist or blacklist:
 
    [bookmark: pgfId-7619078]Access: Admin/Network Admin
 
    
 ). 
    
 
    [bookmark: pgfId-7619083]The Global Whitelist or Global Blacklist pop-up window appears.
 ). 
    
 
    [bookmark: pgfId-7619092]To delete multiple IP addresses at once, use the Shift and Ctrl keys to select them, then right-click and select Delete.
 
    [bookmark: pgfId-7619093]Step 3 Click Save.
 
    [bookmark: pgfId-7619094]Your changes are saved, but you must apply your access control policies for them to take effect
 
    [bookmark: pgfId-8105562]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8105565][bookmark: 77067]Working with the [bookmark: marker-8105564]Intelligence Feed
 
    [bookmark: pgfId-8105572]License: Protection
 
    [bookmark: pgfId-8107962]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-7619112]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-8105535]To help you build blacklists, Cisco provides the Intelligence Feed (sometimes called the Sourcefire Intelligence Feed), which is comprised of several regularly updated lists of IP addresses determined by the VRT to have a poor reputation. Each list in the Intelligence Feed represents a specific category: open relays, known attackers, bogus IP addresses (bogon), and so on. In an access control policy, you can blacklist any or all of the categories. 
 
    [bookmark: pgfId-8105539]Because the Intelligence Feed is regularly updated, the system can use up-to-date information to filter your network traffic. Malicious IP addresses that represent security threats such as malware, spam, botnets, and phishing may appear and disappear faster than you can update and apply new policies.
 
    [bookmark: pgfId-7619124]Although you cannot delete the Intelligence Feed, editing it allows you to change the frequency of its updates. By default, the feed updates every two hours.
 
    [bookmark: pgfId-7619125]To modify the Intelligence Feed’s update frequency:
 
    [bookmark: pgfId-7619126]Access: Admin/Network Admin
 
    
 ). 
    
 
    [bookmark: pgfId-7619137]The Sourcefire Security Intelligence pop-up window appears.
 
    [bookmark: pgfId-7619142]Step 2 Edit the Update Frequency.
 
    [bookmark: pgfId-7619143]You can select from various intervals from two hours to one week. You can also disable feed updates.
 
    [bookmark: pgfId-7619144]Step 3 Click Save.
 
    [bookmark: pgfId-7619145]Your changes are saved.
 
    [bookmark: pgfId-7994615]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619147][bookmark: 83849]Working with Custom Security Intelligence Feeds
 
    [bookmark: pgfId-7619151]License: Protection
 
    [bookmark: pgfId-8107986]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-7619159]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-7619160]Custom or third-party Security Intelligence feeds allow you to augment the Intelligence Feed with other regularly-updated reputable whitelists and blacklists on the Internet. You can also set up an internal feed, which is useful if you want to update multiple Defense Centers in your deployment using one source list.
 
    [bookmark: pgfId-7619167]When you configure a feed, you specify its location using a URL; the URL cannot be Punycode-encoded. By default, the Defense Center downloads the entire feed source on the interval you configure, then automatically updates its managed devices.
 
    [bookmark: pgfId-7619171]Optionally, you can configure the system to use an md5 checksum to determine whether to download an updated feed. If the checksum has not changed since the last time the Defense Center downloaded the feed, the system does not need to re-download it. You may want to use md5 checksums for internal feeds, especially if they are large. The md5 checksum must be stored in a simple text file with only the checksum. Comments are not supported.
 
    [bookmark: pgfId-7619175]To configure a Security Intelligence feed:
 
    [bookmark: pgfId-7619176]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-7619177]Step 1 On the object manager’s Security Intelligence page, click Add Security Intelligence.
 
    [bookmark: pgfId-7619178]The Security Intelligence pop-up window appears.
 
    [bookmark: pgfId-7619183]Step 2 Type a Name for the feed. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-7619184]Step 3 From the Type drop-down list, specify that you want to configure a Feed.
 
    [bookmark: pgfId-7619185]The pop-up window updates with new options.
 
    [bookmark: pgfId-7619190]Step 4 Specify a Feed URL and optionally, an MD5 URL.
 
    [bookmark: pgfId-7619191]Step 5 Select an Update Frequency.
 
    [bookmark: pgfId-7619192]You can select from various intervals from two hours to one week. You can also disable feed updates.
 
    [bookmark: pgfId-7619193]Step 6 Click Save.
 
    [bookmark: pgfId-7619194]The Security Intelligence feed object is created. Unless you disabled feed updates, the Defense Center attempts to download and verify the feed. You can now use the feed object in access control policies.
 
    [bookmark: pgfId-7994656]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619199][bookmark: 75247]Manually Updating Security Intelligence Feeds
 
    [bookmark: pgfId-7619203]License: Protection
 
    [bookmark: pgfId-8108010]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-7619211]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-7917992]Manually updating Security Intelligence feeds updates all feeds, including the Intelligence Feed.
 
    [bookmark: pgfId-7917996]To update all Security Intelligence feeds:
 
    [bookmark: pgfId-7619217]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-7619218]Step 1 On the object manager’s Security Intelligence page, click Update Feeds.
 
    [bookmark: pgfId-7619219]Step 2 Confirm that you want to update all feeds.
 
    [bookmark: pgfId-7619220]A confirmation dialog appears, warning you that it can take several minutes for the update to take effect.
 
    [bookmark: pgfId-7619221]Step 3 Click OK.
 
    [bookmark: pgfId-7619225]After the Defense Center downloads and verifies the feed updates, it communicates any changes to its managed devices. Your deployment begins filtering traffic using the updated feeds.
 
    [bookmark: pgfId-7994675]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619228][bookmark: 96122]Working with Custom [bookmark: marker-7619227]Security Intelligence Lists
 
    [bookmark: pgfId-7619232]License: Protection
 
    [bookmark: pgfId-8108030]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-7619240]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-7619241]A Security Intelligence list is a simple static list of IP addresses and address blocks that you manually upload to the Defense Center. Custom lists are useful if you want to augment and fine-tune feeds or one of the global lists, for a single Defense Center’s managed devices.
 
    [bookmark: pgfId-7619248]Note that netmasks for address blocks can be integers from 0 to 32 or 0 to 128, for IPv4 and IPv6, respectively. 
 
    [bookmark: pgfId-7619249]For example, if a reputable feed improperly blocks your access to vital resources but is overall useful to your organization, you can create a custom whitelist that contains only the improperly classified IP addresses, rather than removing the Security Intelligence feed object from the access control policy’s blacklist.
 
    [bookmark: pgfId-7619250]Note that to modify a Security Intelligence list, you must make your changes to the source file and upload a new copy. For more information, see Updating a Security Intelligence List.
 
    [bookmark: pgfId-7619257]To upload a new Security Intelligence list to the Defense Center:
 
    [bookmark: pgfId-7619258]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-7619259]Step 1 On the object manager’s Security Intelligence page, click Add Security Intelligence.
 
    [bookmark: pgfId-7619260]The Security Intelligence pop-up window appears.
 
    [bookmark: pgfId-7619265]Step 2 Type a Name for the list. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-7619266]Step 3 From the Type drop-down list, specify that you want to upload a List.
 
    [bookmark: pgfId-7619267]The pop-up window updates with new options.
 
    [bookmark: pgfId-7619272]Step 4 Click Browse to browse to the list .txt file, then click Upload.
 
    [bookmark: pgfId-7619273]The list is uploaded. The pop-up window displays the total number of IP addresses and address blocks that the system found in the list.
 
    [bookmark: pgfId-7619278]If the number is not what you expected, check the formatting of the file and try again.
 
    [bookmark: pgfId-7619279]Step 5 Click Save.
 
    [bookmark: pgfId-7619280]The Security Intelligence list object is saved. You can now use it in access control policies.
 
    [bookmark: pgfId-7994706]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619282][bookmark: 66859]Updating a Security Intelligence List
 
    [bookmark: pgfId-7619286]License: Protection
 
    [bookmark: pgfId-8108050]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-7619294]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-7619295]To edit a Security Intelligence list, you must make your changes to the source file and upload a new copy. You cannot modify the file’s contents using the Defense Center web interface. If you do not have access to the source file, you can download a copy from the Defense Center.
 
    [bookmark: pgfId-7619302]To modify a Security Intelligence list:
 
    [bookmark: pgfId-7619303]Access: Admin/Access Admin/Network Admin
 
    
 ). 
    
 
    [bookmark: pgfId-7619308]The Security Intelligence pop-up window appears.
 
    [bookmark: pgfId-7619313]Step 2 If you need a copy of the list to edit, click Download, then follow your browser’s prompts to save the list as a text file.
 
    [bookmark: pgfId-7619314]Step 3 Make changes to the list as necessary.
 
    [bookmark: pgfId-7619315]Step 4 On the Security Intelligence pop-up window, click Browse to browse to the modified list, then click Upload.
 
    [bookmark: pgfId-7619316]The list is uploaded.
 
    [bookmark: pgfId-7619317]Step 5 Click Save.
 
    [bookmark: pgfId-7619318]Your changes are saved. If the list is being used by an active access control policy, you must apply the policy for your changes to take effect.
 
    [bookmark: pgfId-7994722]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619322][bookmark: 41283]Working wi[bookmark: marker-7619321]th Port Objects
 
    [bookmark: pgfId-7619323]License: Any
 
    [bookmark: pgfId-7619324]Port objects represent different protocols in slightly different ways:
 
     
     	 [bookmark: pgfId-7619326]For TCP and UDP, a port object represents the transport layer protocol, with the protocol number in parentheses, plus an optional associated port or port range. For example:  TCP(6)/22 . 
 
     	 [bookmark: pgfId-7619327]For ICMP and ICMPv6 (IPv6-ICMP), the port object represents the Internet layer protocol plus an optional type and code. For example:  ICMP(1):3:3 . 
 
     	 [bookmark: pgfId-7619328]A port object can also represent other protocols that do not use ports. 
 
    
 
    [bookmark: pgfId-7619332]Note that Cisco provides default port objects for well-known ports. You can modify or delete these objects, but Cisco recommends that you create custom port objects instead. 
 
    [bookmark: pgfId-7619339]You can use port objects and groups (see Grouping Objects) in various places in the system’s web interface, including access control policies, network discovery rules, port variables, and event searches. For example, if your organization uses a custom client that uses a specific range of ports and causes the system to generate excessive and misleading events, you can configure your network discovery policy to exclude monitoring those ports.
 
    [bookmark: pgfId-7619340]You cannot delete a port object that is in use. Additionally, after you edit a port object used in an access control or network discovery policy, you must reapply the policy for your changes to take effect.
 
    [bookmark: pgfId-7619341]Note that you cannot add any protocol other than TCP or UDP for source port conditions in access control rules. Also, you cannot mix transport protocols when setting both source and destination port conditions in a rule. 
 
    [bookmark: pgfId-7619342]If you add an unsupported protocol to a port object group used in a source port condition, the rule where it is used does not apply to the managed device on policy apply. Additionally, if you create a port object containing both TCP and UDP ports, then add it as a source port condition in a rule, you cannot add a destination port, and vice versa. 
 
    [bookmark: pgfId-7619343]To create a port object:
 
    [bookmark: pgfId-7619344]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-7619345]Step 1 Select Objects > Object Management.
 
    [bookmark: pgfId-7619346]The Object Management page appears.
 
    [bookmark: pgfId-7619347]Step 2 Under Port, select Individual Objects.
 
    [bookmark: pgfId-7619348]Step 3 Click Add Port.
 
    [bookmark: pgfId-7619349]The Port Objects pop-up window appears.
 
    [bookmark: pgfId-7619354]Step 4 Type a Name for the port object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-7619355]Step 5 Select a Protocol.
 
    [bookmark: pgfId-7619356]You can quickly select TCP, UDP, IP, ICMP, or IPv6-ICMP, or you can use the Other drop-down list to select either a different protocol or All protocols.
 
    [bookmark: pgfId-7619357]Step 6 Optionally, restrict a TCP or UDP port object using a Port or port range.
 
    [bookmark: pgfId-7619358]You can specify any port from 1 to 65535 or any to match all ports. Use a hyphen to specify a range of ports.
 
    [bookmark: pgfId-7619359]Step 7 Optionally, restrict an ICMP or IPV6-ICMP port object using a Type and, if appropriate, a related Code. 
 
    [bookmark: pgfId-7619360]When you create an ICMP or IPv6-ICMP object, you can specify the type and, if applicable, the code. For more information on ICMP types and codes, see:
 
     
     	 [bookmark: pgfId-8133973] http://www.iana.org/assignments/icmp-parameters/icmp-parameters.xml 
 
     	 [bookmark: pgfId-8133997] http://www.iana.org/assignments/icmpv6-parameters/icmpv6-parameters.xml 
 
    
 
    [bookmark: pgfId-8133832]You can set the type to any to match any type or set the code to any to match any code for the specified type.
 
    [bookmark: pgfId-7619363]Step 8 Optionally, select Other and a protocol from the drop-down list. If you select All protocols, type a port number in the Port field. 
 
    [bookmark: pgfId-7619364]Step 9 Click Save.
 
    [bookmark: pgfId-7619365]The port object is added.
 
    [bookmark: pgfId-7994738]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619369][bookmark: 19424]Working with VLAN Tag O[bookmark: marker-7619368]bjects
 
    [bookmark: pgfId-7619370]License: Any
 
    [bookmark: pgfId-7619372]Each VLAN tag object you configure represents a VLAN tag or range of tags. You can use VLAN tag objects and groups (see Grouping Objects) in various places in the system’s web interface, including access control policies and event searches. For example, you could write an access control rule that applies only to a specific VLAN.
 
    [bookmark: pgfId-7619376]You cannot delete a VLAN tag object that is in use. Additionally, after you edit a VLAN tag object used in an access control policy, you must reapply the policy for your changes to take effect.
 
    [bookmark: pgfId-7619377]To add a VLAN tag object:
 
    [bookmark: pgfId-7619378]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-7619379]Step 1 Select Objects > Object Management.
 
    [bookmark: pgfId-7619380]The Object Management page appears.
 
    [bookmark: pgfId-8138527]Step 2 Under VLAN Tag, select Individual Objects.
 
    [bookmark: pgfId-8138528]Step 3 Click Add VLAN Tag.
 
    [bookmark: pgfId-8138529]The VLAN Tag pop-up window appears.
 
    [bookmark: pgfId-7619388]Step 4 Type a Name for the VLAN tag. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-7619389]Step 5 In the VLAN Tag field, type a value for the VLAN tag.
 
    [bookmark: pgfId-7619390]You can specify any VLAN tag from 1 to 4094. Use a hyphen to specify a range of VLAN tags.
 
    [bookmark: pgfId-7619391]Step 6 Click Save.
 
    [bookmark: pgfId-7619392]The VLAN tag object is added.
 
    [bookmark: pgfId-7994753]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619396][bookmark: 85339]Working with URL Obj[bookmark: marker-7619395]ects
 
    [bookmark: pgfId-7619397]License: Any
 
    [bookmark: pgfId-8108070]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-7619405]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-7619407]Each URL object you configure represents a single URL or IP address. You can use URL objects and groups (see Grouping Objects) in various places in the system’s web interface, including access control policies and event searches. For example, you could write an access control rule that blocks a specific website.
 
    [bookmark: pgfId-8106722]When creating URL objects, especially if you do not configure SSL inspection to decrypt or block encrypted traffic, keep the following points in mind:
 
     
     	 [bookmark: pgfId-8107016]If you plan to use a URL object to match HTTPS traffic in an access control rule, create the object using the subject common name in the public key certificate used to encrypt the traffic. Also, the system disregards subdomains within the subject common name, so do not include subdomain information. For example, use example.com rather than www.example.com. 
 
     	 [bookmark: pgfId-8106955]When matching web traffic using access control rules with URL conditions, the system disregards the encryption protocol (HTTP vs HTTPS). In other words, if you block a website, both HTTP and HTTPS traffic to that website is blocked, unless you use an application condition to refine the rule. When creating a URL object, you do not need to specify the protocol when creating an object. For example, use  example.com rather than  http://example.com/ . 
 
    
 
    [bookmark: pgfId-8107848]For more information, see Understanding Traffic Decryption and Blocking URLs.
 
    [bookmark: pgfId-8107738]You cannot delete a URL object that is in use. Additionally, after you edit a URL object used in an access control policy, you must reapply the policy for your changes to take effect.
 
    [bookmark: pgfId-7619413]To add a URL object:
 
    [bookmark: pgfId-7619414]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-7619415]Step 1 Select Objects > Object Management.
 
    [bookmark: pgfId-7619416]The Object Management page appears.
 
    [bookmark: pgfId-7619417]Step 2 Under URL, select Individual Objects.
 
    [bookmark: pgfId-7619418]Step 3 Click Add URL.
 
    [bookmark: pgfId-7619419]The URL Objects pop-up window appears.
 
    [bookmark: pgfId-7619424]Step 4 Type a Name for the URL object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-7619425]Step 5 Type the URL or IP address for the URL object. You cannot use wildcards (*) in this field.
 
    [bookmark: pgfId-7619426]Step 6 Click Save.
 
    [bookmark: pgfId-7619427]The URL object is added.
 
    [bookmark: pgfId-7994892]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7619431][bookmark: 11726]Working with Applic[bookmark: marker-7619430]ation Filters
 
    [bookmark: pgfId-7619436]License: FireSIGHT
 
    [bookmark: pgfId-8108090]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-7619447]When the FireSIGHT System analyzes IP traffic, it attempts to identify the commonly used applications on your network. Application awareness is crucial to performing application-based access control. The system is delivered with detectors for many applications, and Cisco frequently updates and adds additional detectors via system and vulnerability database (VDB) updates. You can also create your own application protocol detectors to enhance the system’s detection capabilities.
 
    [bookmark: pgfId-7619451]Application filters group applications according to criteria associated with the applications’ risk, business relevance, type, categories, and tags; see Table 45-2. When you create an application protocol detector, you must characterize the application using those criteria as well. Using application filters allows you to quickly create application conditions for access control rules because you do not have to search for and add applications individually; for more information, see Matching Traffic with Application Filters.
 
    [bookmark: pgfId-7619458]Another advantage to using application filters is that you do not have to update access control rules that use filters when you modify or add new applications. For example, if you configure your access control policy to block all social networking applications, and a VDB update includes a new social networking application detector, the policy is updated when you update the VDB. Although you must reapply the policy before the system can block the new application, you do not have to update the access control rule that blocks the application.
 
    [bookmark: pgfId-7619462]If the Cisco-provided application filters do not group applications according to your needs, you can create your own filters. User-defined filters can group and combine Cisco-provided filters. For example, you could create a filter that would allow you to block all very high risk, low business relevance applications. You can also create a filter by manually specifying individual applications, although you should keep in mind those filters do not automatically update when you update the system software or the VDB.
 
    [bookmark: pgfId-7619469]As with Cisco-provided application filters, you can use user-defined application filters in access control rules. You can also use user-defined filters in the following additional ways:
 
     
     	 [bookmark: pgfId-7619472]To search for applications using the event viewer; see Using Objects and Application Filters in Searches
 
     	 [bookmark: pgfId-7619476]To constrain a table view in a report template; see Working with Searches in Report Template Sections
 
     	 [bookmark: pgfId-7619478]To filter application statistics in a Custom Analysis dashboard widget; see Configuring the Custom Analysis Widget
 
    
 
    [bookmark: pgfId-7619482]You use the object manager (Objects > Object Management) to create and manage application filters. Note that you can also create an application filter on the fly while adding an application condition to an access control rule.
 
    [bookmark: pgfId-7619490]The Application Filters list contains the Cisco-provided application filters that you can select to build your own filter. You can constrain the filters that appear by using a search string; this is especially useful for categories and tags. 
 
    [bookmark: pgfId-7619491]The Available Applications list contains the individual applications in the filters you select. You can also constrain the applications that appear by using a search string.
 
    [bookmark: pgfId-7619492]The system links multiple filters of the same filter type with an OR operation. Consider a scenario where the medium risk filter contains 100 applications and the high risk filter contains 50 applications. If you select both filters, the system would display 150 available applications.
 
    [bookmark: pgfId-7619493]The system links different types of filters with an AND operation. For example, if you select the medium and high risk filters and the medium and high business relevance filters, the system displays the applications that have medium or high risk, and also have medium or high business relevance.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7619498]After you determine the applications you want to add to the filter, you can add them either individually, or, if you selected an application filter, All apps matching the filter. You can add multiple filters and multiple applications, in any combination, as long as the total number of items in the Selected Applications and Filters list does not exceed 50.
 
   [bookmark: pgfId-7619499]After you create the application filter, it is listed on the Application Filters page of the object manager. The page displays the total number of conditions that comprise each filter.
 
   [bookmark: pgfId-7619504]For information on sorting and filtering the application filters that appear, see Using the Object Manager. Note that you cannot delete an application filter that is in use. Additionally, after you edit an application filter used in an access control policy, you must reapply the policy for your changes to take effect.
 
   [bookmark: pgfId-7619508]To create an application filter:
 
   [bookmark: pgfId-7619509]Access: Admin/Access Admin/Network Admin
 
   
 
   [bookmark: pgfId-7619510]Step 1 Select Objects > Object Management.
 
   [bookmark: pgfId-7619511]The Object Management page appears.
 
   [bookmark: pgfId-7619512]Step 2 Click Application Filters.
 
   [bookmark: pgfId-7619513]The Application Filters section appears.
 
   [bookmark: pgfId-7619514]Step 3 Click Add Application Filter.
 
   [bookmark: pgfId-8138649]The Application Filter pop-up window appears.
 
   [bookmark: pgfId-8138650]Step 4 Give the filter a Name. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
   [bookmark: pgfId-7619520]Step 5 Optionally, use Cisco-provided filters in the Application Filters list to narrow the list of applications you want to add to the filter:
 
    
     
     	 [bookmark: pgfId-7619521]Click the arrow next to each filter type to expand and collapse the list.
 
     	 [bookmark: pgfId-7619522]Right-click a filter type and click  Check All or  Uncheck All . Note that the list indicates how many filters you have selected of each type. 
 
     	 [bookmark: pgfId-7619523]To narrow the filters that appear, type a search string in the  Search by name field; this is especially useful for categories and tags. To clear the search, click the clear icon —
 
    
 
    [image: ] . 
   
 
    
     
     	 [bookmark: pgfId-7619527]To refresh the filters list and clear any selected filters, click the reload icon (
 
    
 
    [image: ] ). 
   
 
    
     
     	 [bookmark: pgfId-7619531]To clear all filters and search fields, click  Clear All Filters .
 
    
 
   
 
   [bookmark: pgfId-7619532]The applications that match the filters you select appear in the Available Applications list. The list displays 100 applications at a time.
 
   [bookmark: pgfId-7619533]Step 6 Select the applications that you want to add to the filter from the Available Applications list:
 
    
     
     	 [bookmark: pgfId-7619534]Select  All apps matching the filter to add all the applications that meet the constraints you specified in the previous step.
 
     	 [bookmark: pgfId-7619535]To narrow the individual applications that appear, type a search string in the  Search by name field. To clear the search, click the clear icon (
 
    
 
    [image: ] ). 
   
 
    
     
     	 [bookmark: pgfId-7619539]Use the paging icons at the bottom of the list to browse the list of individual available applications.
 
     	 [bookmark: pgfId-7619540]Use Shift and Ctrl keys to select multiple individual applications. Right-click to  Select All currently displayed individual applications. 
 
     	 [bookmark: pgfId-7619541]To refresh the applications list and clear any selected applications, click the reload icon (
 
    
 
    [image: ] ). 
   
 
   [bookmark: pgfId-8135932]You cannot select individual applications and All apps matching the filter at the same time.
 
   [bookmark: pgfId-8135933]Step 7 Add the selected applications to the filter. You can click and drag, or you can click Add to Rule.
 
   [bookmark: pgfId-8135934]The result is the combination of:
 
    
     
     	 [bookmark: pgfId-7619548]the selected Application Filters
 
     	 [bookmark: pgfId-7619549]either the selected individual Available Applications, or  All apps matching the filter 
 
    
 
   
 . 
   
 
   [bookmark: pgfId-7619554]Step 8 Click Save.
 
   [bookmark: pgfId-7849350]The application filter is saved.
 
   [bookmark: pgfId-7994916]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7849355][bookmark: 37086]Working with Vari[bookmark: marker-7849354]able Sets
 
    [bookmark: pgfId-7849359]License: Protection
 
    [bookmark: pgfId-7849332]Variables represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions, adaptive profiles, and dynamic rule states.
 
     
      
    
 
    
 
    [bookmark: pgfId-7837621]Tip Preprocessor rules can trigger events regardless of the hosts defined by network variables used in intrusion rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7837622]You use variable sets to manage, customize, and group your variables. You can use the default variable set provided by Cisco or create your own cus[bookmark: marker-7843392]tom sets. Within any set you can modify predefined default variables and add and modify user-defined variables.
 
    [bookmark: pgfId-7783149]Most of the shared object rules and standard text rules that the FireSIGHT System provides use predefined default variables to define networks and port numbers. For example, the majority of the rules use the variable $HOME_NET to specify the protected network and the variable $EXTERNAL_NET to specify the unprotected (or outside) network. In addition, specialized rules often use other predefined variables. For example, rules that detect exploits against web servers use the $HTTP_SERVERS and $HTTP_PORTS variables.
 
    [bookmark: pgfId-7783151]Rules are more effective when variables more accurately reflect your network environment. At a minimum, you should modify default variables in the default set as described in Optimizing Predefined Default Variables. By ensuring that a variable such as $HOME_NET correctly defines your network and $HTTP_SERVERS includes all web servers on your network, processing is optimized and all relevant systems are monitored for suspicious activity.
 
    [bookmark: pgfId-7767413]To use your variables, you link variable sets to intrusion policies associated with access control rules or with the default action of an access control policy. By default, the default variable set is linked to all intrusion policies used by access control policies.
 
    [bookmark: pgfId-7619594]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7672666]Optimizing Predefined Default Variables
 
     	 [bookmark: pgfId-7783056]Understanding Variable Sets
 
     	 [bookmark: pgfId-7672672]Managing Variable Sets
 
     	 [bookmark: pgfId-7804104]Managing Variables
 
     	 [bookmark: pgfId-7804108]Adding and Editing Variables
 
     	 [bookmark: pgfId-7804112]Resetting Variables
 
     	 [bookmark: pgfId-8159388]Nesting Variables
 
     	 [bookmark: pgfId-7804116]Linking Variable Sets to Intrusion Policies
 
     	 [bookmark: pgfId-7756138]Understanding Advanced Variables
 
    
 
     
      [bookmark: pgfId-7756166][bookmark: 56306]Optimizing Predefined Default Varia[bookmark: marker-7756165]bles
 
     [bookmark: pgfId-7768411]License: Protection
 
     [bookmark: pgfId-7768415]By default, the FireSIGHT System provides a single default variable set, which is comprised of predefined default variables. The Cisco Vulnerability Research Team (VRT) uses rule updates to provide new and updated intrusion rules and other intrusion policy elements, including default variables. See Importing Rule Updates and Local Rule Files for more information.
 
     [bookmark: pgfId-7815350]Because many intrusion rules provided by Cisco use predefined default variables, you should set appropriate values for these variables. Depending on how you use variable sets to identify traffic on your network, you can modify the values for these default variables in any or all variable sets. See Adding and Editing Variables for more information.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7857736] 
      Caution Importing an access control or an intrusion policy overwrites existing default variables in the default variable set with the imported default variables. If your existing default variable set contains a custom variable not present in the imported default variable set, the unique variable is preserved. For more information, see 
      Importing Configurations. 
       
       
 
      
 
     
 
      
       
        
        [bookmark: pgfId-7619674]Table 3-2 Variables Provided by Cisco 
 
        
        
         
         	 
           
           [bookmark: pgfId-7619680]Variable Name 
          
  
         	 
           
           [bookmark: pgfId-7619682]Description 
          
  
         	 
           
           [bookmark: pgfId-7619684]Modify? 
          
  
        
 
         
         	[bookmark: pgfId-7619687][bookmark: marker-7619686]$AIM_SERVERS
  
         	[bookmark: pgfId-7619689]Defines known AOL Instant Messenger (AIM) servers, and is used in chat-based rules and rules that look for AIM exploits.
  
         	[bookmark: pgfId-7619691]Not required.
  
        
 
         
         	[bookmark: pgfId-7619694][bookmark: marker-7619693]$DNS_SERVERS
  
         	[bookmark: pgfId-7619696]Defines Domain Name Service (DNS) servers. If you create a rule that affects DNS servers specifically, you can use the $DNS_SERVERS variable as a destination or source IP address.
  
         	[bookmark: pgfId-7619698]Not required in current rule set.
  
        
 
         
         	[bookmark: pgfId-7619701][bookmark: marker-7619700]$EXTERNAL_NET
  
         	[bookmark: pgfId-7619705]Defines the network that the FireSIGHT System views as the unprotected network, and is used in many rules to define the external network.
  
         	[bookmark: pgfId-7619708]Yes, you should adequately define $HOME_NET and then exclude $HOME_NET as the value for $EXTERNAL_NET.
  
        
 
         
         	[bookmark: pgfId-7619711][bookmark: marker-7619710]$FILE_DATA_PORTS
  
         	[bookmark: pgfId-7619713]Defines non-encrypted ports used in intrusion rules that detect files in a network stream.
  
         	[bookmark: pgfId-7619715]Not required.
  
        
 
         
         	[bookmark: pgfId-7619717]$[bookmark: marker-7808449]FTP_PORTS
  
         	[bookmark: pgfId-7619719]Defines the ports of FTP servers on your network, and is used for FTP server exploit rules.
  
         	[bookmark: pgfId-7619721]Yes, if your FTP servers use ports other than the default ports (you can view the default ports in the web interface).
  
        
 
         
         	[bookmark: pgfId-7619724][bookmark: marker-7619723]$GTP_PORTS
  
         	[bookmark: pgfId-7619726]Defines the data channel ports where the packet decoder extracts the payload inside a GTP (General Packet Radio Service [GPRS] Tunneling Protocol) PDU.
  
         	[bookmark: pgfId-7619728]Not required.
  
        
 
         
         	[bookmark: pgfId-7619731][bookmark: marker-7619730]$HOME_NET
  
         	[bookmark: pgfId-7619733]Defines the network that the associated intrusion policy monitors, and is used in many rules to define the internal network.
  
         	[bookmark: pgfId-7619735]Yes, to include the IP addresses for your internal network.
  
        
 
         
         	[bookmark: pgfId-7619738][bookmark: marker-7619737]$HTTP_PORTS
  
         	[bookmark: pgfId-7619740]Defines the ports of web servers on your network, and is used for web server exploit rules.
  
         	[bookmark: pgfId-7619742]Yes, if your web servers use ports other than the default ports (you can view the default ports in the web interface).
  
        
 
         
         	[bookmark: pgfId-7619745][bookmark: marker-7619744]$HTTP_SERVERS
  
         	[bookmark: pgfId-7619747]Defines the web servers on your network. Used in web server exploit rules.
  
         	[bookmark: pgfId-7619749]Yes, if you run HTTP servers.
  
        
 
         
         	[bookmark: pgfId-7619752][bookmark: marker-7619751]$ORACLE_PORTS
  
         	[bookmark: pgfId-7619754]Defines Oracle database server ports on your network, and is used in rules that scan for attacks on Oracle databases.
  
         	[bookmark: pgfId-7619756]Yes, if you run Oracle servers.
  
        
 
         
         	[bookmark: pgfId-7619759][bookmark: marker-7619758]$SHELLCODE_PORTS
  
         	[bookmark: pgfId-7619761]Defines the ports you want the system to scan for shell code exploits, and is used in rules that detect exploits that use shell code.
  
         	[bookmark: pgfId-7619763]Not required.
  
        
 
         
         	[bookmark: pgfId-7619766][bookmark: marker-7619765]$SIP_PORTS
  
         	[bookmark: pgfId-7619768]Defines the ports of SIP servers on your network, and is used for SIP exploit rules.
  
         	[bookmark: pgfId-7619770]Not required.
  
        
 
         
         	[bookmark: pgfId-7619773][bookmark: marker-7619772]$SIP_SERVERS
  
         	[bookmark: pgfId-7619775]Defines SIP servers on your network, and is used in rules that address SIP-targeted exploits.
  
         	[bookmark: pgfId-7619777]Yes, if you run SIP servers, you should adequately define $HOME_NET and then include $HOME_NET as the value for $SIP_SERVERS.
  
        
 
         
         	[bookmark: pgfId-7619780][bookmark: marker-7619779]$SMTP_SERVERS
  
         	[bookmark: pgfId-7619782]Defines SMTP servers on your network, and is used in rules that address exploits that target mail servers.
  
         	[bookmark: pgfId-7619784]Yes, if you run SMTP servers.
  
        
 
         
         	[bookmark: pgfId-7619787]$[bookmark: marker-7619786]SNMP_SERVERS
  
         	[bookmark: pgfId-7619789]Defines SNMP servers on your network, and is used in rules that scan for attacks on SNMP servers.
  
         	[bookmark: pgfId-7619791]Yes, if you run SNMP servers.
  
        
 
         
         	[bookmark: pgfId-7791414]$[bookmark: marker-7791413]SNORT_BPF
  
         	[bookmark: pgfId-7791416]Identifies a legacy advanced variable that appears only when it existed on your system in a FireSIGHT System software release before Version 5.3.0 that you subsequently upgraded to Version 5.3.0 or greater. See Understanding Advanced Variables.
  
         	[bookmark: pgfId-7791418]No, you can only view or delete this variable. You cannot edit it or recover it after deleting it.
  
        
 
         
         	[bookmark: pgfId-7619794][bookmark: marker-7619793]$SQL_SERVERS
  
         	[bookmark: pgfId-7619796]Defines database servers on your network, and is used in rules that address database-targeted exploits.
  
         	[bookmark: pgfId-7619798]Yes, if you run SQL servers.
  
        
 
         
         	[bookmark: pgfId-7619801][bookmark: marker-7619800]$SSH_PORTS
  
         	[bookmark: pgfId-7619803]Defines the ports of SSH servers on your network, and is used for SSH server exploit rules.
  
         	[bookmark: pgfId-7619805]Yes, if your SSH servers use ports other than the default port (you can view the default ports in the web interface).
  
        
 
         
         	[bookmark: pgfId-7619808][bookmark: marker-7619807]$SSH_SERVERS
  
         	[bookmark: pgfId-7619810]Defines SSH servers on your network, and is used in rules that address SSH-targeted exploits.
  
         	[bookmark: pgfId-7619812]Yes, if you run SSH servers, you should adequately define $HOME_NET and then include $HOME_NET as the value for $SSH_SERVERS.
  
        
 
         
         	[bookmark: pgfId-7619815][bookmark: marker-7619814]$TELNET_SERVERS
  
         	[bookmark: pgfId-7619817]Defines known Telnet servers on your network, and is used in rules that address Telnet server-targeted exploits.
  
         	[bookmark: pgfId-7619819]Yes, if you run Telnet servers.
  
        
 
         
         	[bookmark: pgfId-7791605]$[bookmark: marker-7791604]USER_CONF
  
         	[bookmark: pgfId-7792400]Provides a general tool that allows you to configure one or more features not otherwise available via the web interface. See Understanding Advanced Variables.
 
           
            
          
 
          
 
           
           [bookmark: pgfId-7792137]Caution Conflicting or duplicate 
           $USER_CONF configurations will halt the system. See 
           Understanding Advanced Variables. 
            
            
 
           
 
          
  
         	[bookmark: pgfId-7791612]No, only as instructed in a feature description or with the guidance of Support.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7763478][bookmark: 98253]Understanding Variable Sets[bookmark: marker-7843109]
 
     [bookmark: pgfId-7763482]License: Protection
 
     [bookmark: pgfId-7769389]Adding a variable to any set adds it to all sets; that is, each variable set is a collection of all variables currently configured on your system. Within any variable set, you can add user-defined variables and customize the value of any variable.
 
     [bookmark: pgfId-7769622]Initially, the FireSIGHT System provides a single, default variable set comprised of predefined default values. Each variable in the default set is initially set to its default value, which for a predefined variable is the value set by the VRT and provided in rule updates.
 
     [bookmark: pgfId-7769634]Although you can leave predefined default variables configured to their default values, Cisco recommends that you modify a subset of predefined variables as described in Optimizing Predefined Default Variables.
 
     [bookmark: pgfId-7769640]You could work with variables only in the default set, but in many cases you can benefit most by adding one or more custom sets, configuring different variable values in different sets, and perhaps even adding new variables.
 
     [bookmark: pgfId-7815887]When using multiple sets, it is important to remember that the current value of any variable in the default set determines the default value of the variable in all other sets. 
 
     [bookmark: pgfId-7845475]Example: Adding a User-Defined Variable to the Default Set
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7818702]Optionally, you can customize the value of Var1 in any set. In Custom Set 2 where Var1 has not been customized, its value is 192.168.1.0/24. In Custom Set 1 the customized value 192.168.2.0/24 of Var1 overrides the default value. Resetting a user-defined variable in the default set resets its default value to any in all sets.
 
     [bookmark: pgfId-7817650]It is important to note in this example that, if you do not update Var1 in Custom Set 2, further customizing or resetting Var1 in the default set consequently updates the current, default value of Var1 in Custom Set 2, thereby affecting any intrusion policy linked to the variable set.
 
     [bookmark: pgfId-7825780]Although not shown in the example, note that interactions between sets are the same for user-defined variables and default variables except that resetting a default variable in the default set resets it to the value configured by Cisco in the current rule update.
 
     [bookmark: pgfId-7845621]Examples: Adding a User-Defined Variable to a Custom Set
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7822152]Note that, except for the origin of Var1 from Custom Set 1, this example is identical to the example above where you added Var1 to the default set. Adding the customized value 192.168.1.0/24 for Var1 to Custom Set 1 copies the value to the default set as a customized value with a default value of any. Thereafter, Var1 values and interactions are the same as if you had added Var1 to the default set. As with the previous example, keep in mind that further customizing or resetting Var1 in the default set consequently updates the current, default value of Var1 in Custom Set 2, thereby affecting any intrusion policy linked to the variable set.
 
     [bookmark: pgfId-7820021]In the next example, you add Var1 with the value 192.168.1.0/24 to Custom Set 1 as in the previous example, but you elect not to use the configured value of Var1 as the default value in other sets.
 
      
       [bookmark: pgfId-8152066]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-7826177]This approach adds Var1 to all sets with a default value of any. After adding Var1, you can customize its value in any set. An advantage of this approach is that, by not initially customizing Var1 in the default set, you decrease your risk of customizing the value in the default set and thus inadvertently changing the current value in a set such as Custom Set 2 where you have not customized Var1.
 
     
 
    
 
     
      [bookmark: pgfId-7826179][bookmark: 55747]Managing Varia[bookmark: marker-7843139]ble Sets
 
     [bookmark: pgfId-7619825]License: Protection
 
     [bookmark: pgfId-7619826]When you select Variable Sets on the Object Manager page (Objects > Object Management), the object manager lists the default variable set and any custom sets you created. 
 
     [bookmark: pgfId-7785887]On a freshly installed system, the default variable set is comprised only of the default variables predefined by Cisco.
 
     [bookmark: pgfId-7845716]Each variable set includes the default variables provided by Cisco and all custom variables you have added from any variable set. Note that you can edit the default set, but you cannot rename or delete the default set.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7857637] 
      Caution Importing an access control or an intrusion policy overwrites existing default variables in the default variable set with the imported default variables. If your existing default variable set contains a custom variable not present in the imported default variable set, the unique variable is preserved. For more information, see 
      Importing Configurations. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7619835]The following table summarizes the actions you can take to manage your variable sets.
 
     [bookmark: pgfId-7619899]
 
      
      
 
      
 
      
 
       
        
        [bookmark: pgfId-7619842]Table 3-3 [bookmark: 68656]Variable Set Management Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-7619846]To... 
          
  
         	 
           
           [bookmark: pgfId-7619848]You can... 
          
  
        
 
         
         	[bookmark: pgfId-7619850]display your variable sets
  
         	[bookmark: pgfId-7619852]select Objects > Object Management, then select Variable Set.
  
        
 
         
         	[bookmark: pgfId-7619854]filter variable sets by name
  
         	[bookmark: pgfId-7619856]begin typing a name; as you type, the page refreshes to display matching names.
  
        
 
         
         	[bookmark: pgfId-7619858]clear name filtering
  ) in the filter field. 
        
 
         
         	[bookmark: pgfId-7619865]add a custom variable set
  
         	[bookmark: pgfId-7619867]click Add Variable Set.
 [bookmark: pgfId-8091452]For your convenience, new variable sets contain all currently defined default and customized variables.
 ).
  
        
 
         
         	[bookmark: pgfId-7619870]edit a variable set
  ) next to the variable set you want to edit. . 
        
 
         
         	[bookmark: pgfId-7619878]delete a custom variable set
  . You cannot delete the default variable set. Note that variables created in a variable set you delete are not deleted or otherwise affected in other sets. . Use the Ctrl and Shift keys to select multiple sets. 
        
 
        
      
 
     
 
     [bookmark: pgfId-7826424]After you configure variable sets, you can link them to intrusion policies.
 
     [bookmark: pgfId-7619900]To create or edit a variable set:
 
     [bookmark: pgfId-7850225]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-7619902]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-7619903]The Object Management page appears.
 
     [bookmark: pgfId-7619904]Step 2 Select Variable Set.
 
     [bookmark: pgfId-7619905]Step 3 Add a variable set or edit an existing set:
 
      
       
       	 [bookmark: pgfId-7619906]To add a variable set, click  Add Variable Set .
 
       	 [bookmark: pgfId-7619910]To edit a variable set, click the edit icon (
 
      
 
      [image: ] ) next to the variable set. 
     
 
     [bookmark: pgfId-7619913]The new or edit variable set page appears. When naming a variable set, you can use any printable standard ASCII characters except a pipe (|) or curly braces ({}). See Adding and Editing Variables for information on adding and editing variables within a variable set.
 
     [bookmark: pgfId-7995423]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7619915][bookmark: 16392]Managing Vari[bookmark: marker-7843155]ables
 
     [bookmark: pgfId-7619919]License: Protection
 
     [bookmark: pgfId-7619920]You manage variables on the new or edit variables page within a variable set. The variables page for all variable sets separates variables into Customized Variables and Default Variables page areas.
 
     [bookmark: pgfId-7843171]A default variable is a variable provided by Cisco. You can customize the value of a default variable. You cannot rename or delete a default variable, and you cannot change its default value.
 
     [bookmark: pgfId-7843172]A customized variable[bookmark: marker-7843352] is one of the following:
 
      
      	 [bookmark: pgfId-7843173]customized default variables
 
     
 
     [bookmark: pgfId-7619937]When you edit the value for a default variable, the system moves the variable from the Default Variables area to the Customized Variables area. Because variable values in the default set determine the default values of variables in custom sets, customizing a default variable in the default set modifies the default value of the variable in all other sets.
 
      
      	 [bookmark: pgfId-7619938]us[bookmark: marker-7843361]er-defined variables
 
     
 
     [bookmark: pgfId-7619939]You can add and delete your own variables, customize their values within different variable sets, and reset customized variables to their default values. When you reset a user-defined variable, it remains in the Customized Variables area.
 
      
      
 
      
 
      [bookmark: pgfId-8093462]See Adding and Editing Variables for more information.
 
      
 
      [bookmark: pgfId-8093470] 
      
 
      [bookmark: pgfId-8093478]You cannot delete default variables, and you cannot delete user-defined variables that are used by intrusion rules or other variables.
 
       
        
        [bookmark: pgfId-8093416]Table 3-4 Variable Management Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-8093420]To... 
          
  
         	 
           
           [bookmark: pgfId-8093422]You can... 
          
  
        
 
         
         	[bookmark: pgfId-8093424]display the variables page
  ) next to the variable set you want to edit. 
        
 
         
         	[bookmark: pgfId-8093435]name and, optionally, describe your variable set
  
         	[bookmark: pgfId-8093437]enter an alphanumeric string including spaces and special characters in the Name and Description fields.
 ).
  
        
 
         
         	[bookmark: pgfId-8093440]display the complete value for a variable
  
         	[bookmark: pgfId-8093442]hover your pointer over the value in the Value column next to the variable.
 [bookmark: pgfId-8093443]Note A variable value can include up to 8192 characters. Keep in mind, however, that this limit applies to the size of the expanded value of the variable. If you use one or more variables to define another variable, the total number of characters and spaces of all the variable values cannot exceed 8192 characters.
  
        
 
         
         	[bookmark: pgfId-8093445]add a variable
  
         	[bookmark: pgfId-8093447]click Add.
 [bookmark: pgfId-8093451]See Adding and Editing Variables for more information.
  
        
 
         
         	[bookmark: pgfId-8093453]edit a variable
  ) next to the variable you want to edit. 
        
 
         
         	[bookmark: pgfId-8093464]reset a modified variable to its default value
  ) next to a modified variable. A shaded reset icon indicates that the current value is already the default value. Tip Hover your pointer over an active reset icon to display the default value. 
        
 
         
         	[bookmark: pgfId-8093472]delete a user-defined customized variable
  to confirm that you want to delete the variable. 
        
 
         
         	[bookmark: pgfId-8093480]save changes to a variable set
  
         	[bookmark: pgfId-8093482]click Save, then click Yes if the variable set is in use by an access control policy to confirm that you want to save your changes.
 [bookmark: pgfId-8093483]Because the current value in the default set determines the default value in all other sets, modifying or resetting a variable in the default set changes the current value in other sets where you have not customized the default value.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8093485]To view the variables in a variable set:
 
     [bookmark: pgfId-8093397]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-7796871]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-7796872]The Object Management page appears.
 
     [bookmark: pgfId-7796873]Step 2 Select Variable Set.
 
     [bookmark: pgfId-7796874]Step 3 Add a variable set or edit an existing set:
 
      
       
       	 [bookmark: pgfId-7796875]To add a variable set, click  Add Variable Set .
 
       	 [bookmark: pgfId-7796879]To edit a variable set, click the edit icon (
 
      
 
      [image: ] ) next to the variable set. 
     
 
     [bookmark: pgfId-7796882]The new or edit variable set page appears. When naming a variable set, you can use any printable standard ASCII characters except a pipe (|) or curly braces ({}). 
 
     [bookmark: pgfId-7797044]Step 4 Add a variable or edit an existing variable:
 
      
       
       	 [bookmark: pgfId-7797045]To add a variable, click  Add .
 
       	 [bookmark: pgfId-7797049]To edit a variable, click the edit icon (
 
      
 
      [image: ] ) next to the variable. 
     
 
     [bookmark: pgfId-7797050]The new or edit variable page appears.
 
     [bookmark: pgfId-7797036]See Adding and Editing Variables for information on adding and editing variables within a variable set.
 
     [bookmark: pgfId-7995468]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7620041][bookmark: 41076]Adding and Editing Var[bookmark: marker-7620040]iables
 
     [bookmark: pgfId-7620045]License: Protection
 
     [bookmark: pgfId-7779924]You can modify variables in any custom set.
 
     [bookmark: pgfId-7829198]If you create custom standard text rules, you might also want to add your own user-defined variables to more accurately reflect your traffic or as shortcuts to simplify the rule creation process. For example, if you create a rule that you want to inspect traffic in the “demilitarized zone” (or DMZ) only, you can create a variable named $DMZ whose value lists the server IP addresses that are exposed. You can then use the $DMZ variable in any rule written for this zone.
 
     [bookmark: pgfId-7840620]Adding a variable to a variable set adds it to all other sets. With one exception as explained below, the variable is added to other sets as the default value, which you can then customize.
 
     [bookmark: pgfId-7841714]When you add a variable from a custom set, you must choose whether to use the configured value as the customized value in the default set. 
 
      
      	 [bookmark: pgfId-7845101]If you  do use the configured value (for example, 192.168.0.0/16), the variable is added to the default set using the configured value as a customized value with a default value of  any . Because the current value in the default set determines the default value in other sets, the initial, default value in other custom sets is the configured value (which in the example is 192.168.0.0/16). 
 
      	 [bookmark: pgfId-7845177]If you  do not use the configured value, the variable is added to the default set using only the default value  any and, consequently, the initial, default value in other custom sets is  any .
 
     
 
     [bookmark: pgfId-7845203]See Understanding Variable Sets for more information.
 
     [bookmark: pgfId-7827782]You add variables within a variable set on the New Variable page and edit existing variables on the Edit Variable page. You use the two pages identically except that when you edit an existing variable you cannot change the variable name or variable type.
 
     [bookmark: pgfId-7797162]Each page consists mainly of three windows:
 
      
      	 [bookmark: pgfId-7797163]available items, including existing network or port variables, objects, and network object groups
 
      	 [bookmark: pgfId-7797164]networks or ports to include in the variable definition
 
      	 [bookmark: pgfId-7797165]networks or ports to exclude from the variable definition
 
     
 
     [bookmark: pgfId-7683764]You can create or edit two types of variables:
 
      
      	 [bookmark: pgfId-7671666] network variables specify the IP addresses of hosts in your network traffic. See Working with Network Variables.
 
      	 [bookmark: pgfId-7671688] port variables specify TCP or UDP ports in network traffic, including the value  any for either type. See Working with Port Variables.
 
     
 
     [bookmark: pgfId-7620056]When you specify whether you want to add a network or port variable type, the page refreshes to list available items. A search field above the list allows you to constrain the list, which updates as you type.
 
     [bookmark: pgfId-7620057]You can select and drag available items the list of items to include or exclude. You can also select items and click the Include or Exclude button. Use the Ctrl and Shift keys to select multiple items. You can use the configuration field below the list of included or excluded items to specify literal IP addresses and address blocks for network variables, and ports and port ranges for port variables.
 
     [bookmark: pgfId-7828929]A list of items to include or exclude can be comprised of any combination of literal strings and existing variables, objects, and network object groups in the case of network variables.
 
      
      
 
      Working with Network Objects 
      
 
      
 
      [bookmark: pgfId-7792837]Although you can add any port type, only TCP and UDP ports, including the value any for either type, are valid variable values, and the list of available ports only displays variables that use these value types. See Working with Port Objects for information on adding port objects using the object manager.
 
      
 
      
 
      [bookmark: pgfId-7620143]Note that only network groups, not port groups, are available.
 
      
 
       
        
        [bookmark: pgfId-7620067]Table 3-5 [bookmark: 20370]Variable Edit Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-7620071]To... 
          
  
         	 
           
           [bookmark: pgfId-7620073]You can... 
          
  
        
 
         
         	[bookmark: pgfId-7620075]display the variables page
  ) next to an existing variable. 
        
 
         
         	[bookmark: pgfId-7620082]name your variable
  
         	[bookmark: pgfId-7620084]in the Name field, type a unique, case-sensitive alphanumeric string that includes no special characters other than the underscore character (_).
 [bookmark: pgfId-7805515]Note that variable names are case-sensitive; for example, var and Var are each unique.
  
        
 
         
         	[bookmark: pgfId-7620086]specify a network or port variable
  
         	[bookmark: pgfId-7620088]select Network or Port from the Type drop-down list.
 [bookmark: pgfId-7620092]See Working with Network Variables and Working with Port Variables for detailed information on how you can use and configure network and port variables.
  
        
 
         
         	[bookmark: pgfId-7620094]add an individual network object so you can then select it from the list of available networks
  ). See for information on adding network objects using the object manager. 
        
 
         
         	[bookmark: pgfId-7620104]add an individual port object so you can then select it from the list of available ports
  ). 
        
 
         
         	[bookmark: pgfId-7620114]search for available port or network items by name
  
         	[bookmark: pgfId-7620116]begin typing a name in the search field above the list of available items; as you type, the page refreshes to display matching names.
  
        
 
         
         	[bookmark: pgfId-7620118]clear name searching
  ) in the search field. 
        
 
         
         	[bookmark: pgfId-7620128]differentiate between available items
  ). 
        
 
         
         	[bookmark: pgfId-7620145]select objects to include or exclude in the variable definition
  
         	[bookmark: pgfId-7620147]click the object in the list of available networks or ports; use the Ctrl and Shift keys to select multiple objects.
  
        
 
         
         	[bookmark: pgfId-7620149]add selected items to the list of included or excluded networks or ports
  
         	[bookmark: pgfId-8136234]drag and drop selected items. Alternately, click Include or Exclude.
 [bookmark: pgfId-7828995]You can add network and port variables and objects from the list of available items. You can also add network object groups.
  
        
 
         
         	[bookmark: pgfId-7620154]add a literal network or port to the list of networks or ports to include or exclude
  
         	[bookmark: pgfId-7620156]click to remove the prompt from the literal Network or Port field, type the literal IP address or address block for network variables, or the literal port or port range for port variables, then click Add.
 [bookmark: pgfId-7620157]Note that you cannot enter domain names or lists; to add multiple items, add each individually.
  
        
 
         
         	[bookmark: pgfId-7787432]add a variable with the value any
  
         	[bookmark: pgfId-7787434]name the variable and select the variable type, then click Save without configuring a value.
 ).
  
        
 
         
         	[bookmark: pgfId-7620159]delete a variable or object from the included or excluded list
  ) next to the variable. 
        
 
         
         	[bookmark: pgfId-7620166]save a new or modified variable
  
         	[bookmark: pgfId-7620168]click Save; if you are adding a variable from custom set, then click Yes to use the configured value as the default value in other sets, or No to use a default value of any.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7677169]See the following sections for more information:
 
      
      	 [bookmark: pgfId-7677232]Working with Network Variables
 
      	 [bookmark: pgfId-7677236]Working with Port Variables
 
     
 
     [bookmark: pgfId-7793378]To add or edit a variable:
 
     [bookmark: pgfId-7850259]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-7793380]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-7793381]The Object Management page appears.
 
     [bookmark: pgfId-7793382]Step 2 Select Variable Set.
 
     [bookmark: pgfId-7793383]Step 3 Add a variable set or edit an existing set:
 
      
       
       	 [bookmark: pgfId-7793384]To add a variable set, click  Add Variable Set .
 
       	 [bookmark: pgfId-7793388]To edit an existing variable set, click the edit icon (
 
      
 
      [image: ] ) next to the variable set. 
     
 
     [bookmark: pgfId-7793389]The new or edit variable set page appears. When naming a variable set, you can use any printable standard ASCII characters except a pipe (|) or curly braces ({}). 
 
     [bookmark: pgfId-7793390]Step 4 Add a new variable or edit an existing variable:
 
      
       
       	 [bookmark: pgfId-7793391]To add a new variable, click  Add .
 
       	 [bookmark: pgfId-7793395]To edit an existing variable, click the edit icon (
 
      
 
      [image: ] ) next to the variable. 
     
 
     [bookmark: pgfId-7793396]The new or edit variable page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-7793397]Tip On the variable page, you can use the right-click context menu to select or delete items; see Using the Context Menu.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7793401]Step 5 If you are adding a new variable:
 
      
       
       	 [bookmark: pgfId-7793402]Enter a unique variable  Name .
 
      
 
     
 
     [bookmark: pgfId-7793403]You can use alphanumeric characters and the underscore (_) character.
 
      
       
       	 [bookmark: pgfId-7793404]Select the  Network or  Port variable  Type from the drop-down list.
 
      
 
     
 
     [bookmark: pgfId-7793406]Step 6 Optionally, move items from the list of available networks or ports to the list of included or excluded items. 
 
     [bookmark: pgfId-7793407]You can select one or more items and then drag and drop, or click Include or Exclude. Use the Ctrl and Shift keys to select multiple items. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7793408]Tip If addresses or ports in the included and excluded lists for a network or port variable overlap, excluded addresses or ports take precedence.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7793409]Step 7 Optionally, enter a single literal value, then click Add.
 
     [bookmark: pgfId-7793410]For network variables, you can enter a single IP address or address block. For port variables you can add a single port or port range, separating the upper and lower values with a hyphen (-).
 
     [bookmark: pgfId-7793411]Repeat this step as needed to enter multiple literal values.
 
     [bookmark: pgfId-7793412]Step 8 Click Save to save the variable. If you are adding a new variable from a custom set, you have the following options:
 
      
       
       	 [bookmark: pgfId-7793413]Click  Yes to add the variable using the configured value as the customized value in the default set and, consequently, the default value in other custom sets.
 
       	 [bookmark: pgfId-7793414]Click  No  to add the variable as the default value of  any  in the default set and, consequently, in other custom sets.
 
      
 
     
 
     [bookmark: pgfId-7793415]Step 9 When you have finished making changes, click Save to save the variable set, then click Yes.
 
     [bookmark: pgfId-7793416]Your changes are saved and any access control policy the variable set is linked to displays an out-of-date status. For your changes to take effect, you must apply the access control policy where the variable set is linked to an intrusion policy; see Applying an Access Control Policy.
 
     [bookmark: pgfId-7995495]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7671340][bookmark: 12697]Working with Netw[bookmark: marker-7843254]ork Variables
 
     [bookmark: pgfId-7829975]License: Protection
 
     [bookmark: pgfId-7830004]Network variables represent IP addresses you can use in intrusion rules that you enable in an intrusion policy and in intrusion policy rule suppressions, dynamic rule states, and adaptive profiles. Network variables differ from network objects and network object groups in that network variables are specific to intrusion policies and intrusion rules, whereas you can use network objects and groups to represent IP addresses in various places in the system’s web interface, including access control policies, network variables, intrusion rules, network discovery rules, event searches, reports, and so on. See Working with Network Objects for more information.
 
     [bookmark: pgfId-7835952]You can use network variables in the following configurations to specify the IP addresses of hosts on your network:
 
      
      	 [bookmark: pgfId-7829980]intrusion rules
 
     
 
     [bookmark: pgfId-7671345]Intrusion rule Source IPs and Destination IPs header fields allow you to restrict packet inspection to the packets originating from or destined to specific IP addresses. See Specifying IP Addresses In Intrusion Rules.
 
      
      	 [bookmark: pgfId-7671349]suppressions
 
     
 
     [bookmark: pgfId-7830007]The Network field in source or destination intrusion rule suppressions allows you to suppress intrusion event notifications when a specific IP address or range of IP addresses triggers an intrusion rule or preprocessor. See Configuring Suppression Per Intrusion Policy.
 
      
      	 [bookmark: pgfId-7830013]dynamic rule states
 
     
 
     [bookmark: pgfId-7671355]The Network field in source or destination dynamic rule states allows you to detect when too many matches for an intrusion rule or preprocessor rule occur in a given time period. See Adding Dynamic Rule States.
 
      
      	 [bookmark: pgfId-7671359]adaptive profiles
 
     
 
     [bookmark: pgfId-7671360]The adaptive profiles Networks field identifies hosts in the network map where you want to improve reassembly of packet fragments and TCP streams in passive deployments. See Tuning Preprocessing in Passive Deployments.
 
     [bookmark: pgfId-7831219]When you use variables in the fields identified in this section, the variable set you link to an intrusion policy determines the variable values in the network traffic handled by an access control policy that uses the intrusion policy.
 
     [bookmark: pgfId-7671375]You can add any combination of the following network configurations to a variable:
 
      
      	 [bookmark: pgfId-7671376]any combination of network variables, network objects, and network object groups that you select from the list of available networks
 
     
 
     [bookmark: pgfId-7671377]See Working with Network Objects for information on creating individual and group network objects using the object manager.
 
      
      	 [bookmark: pgfId-7671381]individual network objects that you add from the New Variable or Edit Variable page, and can then add to your variable and to other existing and future variables
 
      	 [bookmark: pgfId-7671382]literal, single IP addresses or address blocks
 
     
 
     [bookmark: pgfId-7682369]You can list multiple literal IP addresses and address blocks by adding each individually. You can list IPv4 and IPv6 addresses and address blocks alone or in any combination. When specifying IPv6 addresses, you can use any addressing convention defined in RFC 4291.
 
     [bookmark: pgfId-7671384]The default value for included networks in any variable you add is the word any, which indicates any IPv4 or IPv6 address. The default value for excluded networks is none, which indicates no network. You can also specify the address :: in a literal value to indicate any IPv6 address in the list of included networks, or no IPv6 addresses in the list of exclusions. 
 
     [bookmark: pgfId-7671385]Adding networks to the excluded list negates the specified addresses and address blocks. That is, you can match any IP address with the exception of the excluded IP address or address blocks. 
 
     [bookmark: pgfId-7671386]For example, excluding the literal address 192.168.1.1 specifies any IP address other than 192.168.1.1, and excluding 2001:db8:ca2e::fa4c specifies any IP address other than 2001:db8:ca2e::fa4c.
 
     [bookmark: pgfId-7671387]You can exclude any combination of networks using literal or available networks. For example, excluding the literal values 192.168.1.1 and 192.168.1.5 includes any IP address other than 192.168.1.1 or 192.168.1.5. That is, the system interprets this as “not 192.168.1.1 and not 192.168.1.5,” which matches any IP address other than those listed between brackets.
 
     [bookmark: pgfId-7802351]Note the following points when adding or editing network variables:
 
      
      	 [bookmark: pgfId-7671388]You cannot logically exclude the value  any which, if excluded, would indicate no address. For example, you cannot add a variable with the value  any to the list of excluded networks.
 
      	 [bookmark: pgfId-7794297]Network variables identify traffic for the specified intrusion rule and intrusion policy features. Note that preprocessor rules can trigger events regardless of the hosts defined by network variables used in intrusion rules.
 
      	 [bookmark: pgfId-7802335]Excluded values must resolve to a subset of included values. For example, you cannot include the address block 192.168.5.0/24 and exclude 192.168.6.0/24. An error message warns you and identifies the offending variable, and you cannot save your variable set when you exclude a value outside the range of included values.
 
     
 
     [bookmark: pgfId-7794414]For information on adding and editing network variables, see Adding and Editing Variables.
 
    
 
     
      [bookmark: pgfId-7671390][bookmark: 76312]Working with [bookmark: marker-7843259]Port Variables
 
     [bookmark: pgfId-7671391]License: Protection
 
     [bookmark: pgfId-8136469]Port variables represent TCP and UDP ports you can use in the Source Port and Destination Port header fields in intrusion rules that you enable in an intrusion policy. Port variables differ from port objects and port object groups in that port variables are specific to intrusion rules. You can create port objects for protocols other than TCP and UDP, and you can use port objects in various places in the system’s web interface, including port variables, access control policies, network discovery rules, and event searches. See Working with Port Objects for more information.
 
     [bookmark: pgfId-8136473]You can use port variables in the intrusion rule Source Port and Destination Port header fields to restrict packet inspection to packets originating from or destined to specific TCP or UDP ports.
 
     [bookmark: pgfId-7673967]When you use variables in these fields, the variable set you link to the intrusion policy associated with an access control rule or policy determines the values for these variables in the network traffic where you apply the access control policy.
 
     [bookmark: pgfId-7675643]You can add any combination of the following port configurations to a variable:
 
      
      	 [bookmark: pgfId-7675644]any combination of port variables and port objects that you select from the list of available ports
 
     
 
     [bookmark: pgfId-7675645]Note that the list of available ports does not display port object groups, and you cannot add these to variables. See Working with Port Objects for information on creating port objects using the object manager.
 
      
      	 [bookmark: pgfId-7801551]individual port objects that you add from the New Variable or Edit Variable page, and can then add to your variable and to other existing and future variables
 
     
 
     [bookmark: pgfId-7801552]Only TCP and UDP ports, including the value any for either type, are valid variable values. If you use the new or edit variables page to add a valid port object that is not a valid variable value, the object is added to the system but is not displayed in the list of available objects. When you use the object manager to edit a port object that is used in a variable, you can only change its value to a valid variable value.
 
      
      	 [bookmark: pgfId-7675650]single, literal port values and port ranges
 
     
 
     [bookmark: pgfId-7675651]You must separate port ranges with a dash (-). Port ranges indicated with a colon (:) are supported for backward compatibility, but you cannot use a colon in port variables that you create.
 
     [bookmark: pgfId-7675652]You can list multiple literal port values and ranges by adding each individually in any combination.
 
     [bookmark: pgfId-7801563]Note the following points when adding or editing port variables:
 
      
      	 [bookmark: pgfId-7801578]The default value for included ports in any variable you add is the word  any , which indicates any port or port range. The default value for excluded ports is  none , which indicates no ports.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7801619]Tip To create a variable with the value any, name and save the variable without adding a specific value.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-7685133]You cannot logically exclude the value  any which, if excluded, would indicate no ports. For example, you cannot save a variable set when you add a variable with the value  any to the list of excluded ports.
 
      	 [bookmark: pgfId-7811031]Adding ports to the excluded list negates the specified ports and port ranges. That is, you can match any port with the exception of the excluded ports or port ranges.
 
      	 [bookmark: pgfId-7811033]Excluded values must resolve to a subset of included values. For example, you cannot include the port range 10-50 and exclude port 60. An error message warns you and identifies the offending variable, and you cannot save your variable set when you exclude a value outside the range of included values.
 
     
 
     [bookmark: pgfId-7793812]For information on adding and editing port variables, see Adding and Editing Variables.
 
    
 
     
      [bookmark: pgfId-7676938][bookmark: 92046]Resetting Var[bookmark: marker-7843264]iables
 
     [bookmark: pgfId-7849407]License: Protection
 
      
       
        
        [bookmark: pgfId-7834110]Table 3-6 Variable Reset Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-7834132]Resetting this variable type... 
          
  
         	 
           
           [bookmark: pgfId-7834114]In this set type... 
          
  
         	 
           
           [bookmark: pgfId-7834116]Resets it to... 
          
  
        
 
         
         	[bookmark: pgfId-7834134]default
  
         	[bookmark: pgfId-7834118]default
  
         	[bookmark: pgfId-7834120]the rule update value
  
        
 
         
         	[bookmark: pgfId-7834136]user-defined
  
         	[bookmark: pgfId-7834122]default
  
         	[bookmark: pgfId-7834124]any
  
        
 
         
         	[bookmark: pgfId-7834138]default or user-defined
  
         	[bookmark: pgfId-7834126]custom
  
         	[bookmark: pgfId-7834128]the current default set value (modified or unmodified)
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7731444]Resetting a variable in a custom set simply resets it to the current value for that variable in the default set.
 
     [bookmark: pgfId-7738787]Conversely, resetting or modifying the value of a variable in the default set always updates the default value of that variable in all custom sets. When the reset icon is grayed out, indicating that you cannot reset the variable, this means that the variable has no customized value in that set. Unless you have customized the value for a variable in a custom set, a change to the variable in the default set updates the value used in any intrusion policy where you have linked the variable set.
 
      
       
     
 
     
 
     [bookmark: pgfId-7834202]Note It is good practice when you modify a variable in the default set to assess how the change affects any intrusion policy that uses the variable in a linked custom set, especially when you have not customized the variable value in the custom set.
 
      
      
 
     
 
     
 ) in a variable set to see the reset value. When the customized value and the reset value are the same, this indicates one of the following: 
     
 
      
      	 [bookmark: pgfId-7740823]you are in the custom or default set where you added the variable with the value  any 
 
      	 [bookmark: pgfId-7740824]you are in the custom set where you added the variable with an explicit value and elected to use the configured value as the default value
 
     
 
    
 
     
      [bookmark: pgfId-8153868][bookmark: 49200]Nesting Variables
 
     [bookmark: pgfId-8154034]You can nest variables so long as the nesting is not circular. Nested, negated variables are not supported.
 
     [bookmark: pgfId-8154035]Example: Valid Nested Variables
 
      
       
        
        [bookmark: pgfId-8159323]Table 3-7 Example: Valid Nested Variables 
 
        
        
         
         	 
           
           [bookmark: pgfId-8159331]Variable. 
          
  
         	 
           
           [bookmark: pgfId-8159333]Type 
          
  
         	 
           
           [bookmark: pgfId-8159335]Included Networks 
          
  
         	 
           
           [bookmark: pgfId-8159337]Excluded Networks 
          
  
        
 
         
         	[bookmark: pgfId-8159339]SMTP_SERVERS
  
         	[bookmark: pgfId-8159341]customized default
  
         	[bookmark: pgfId-8159343]10.1.1.1
  
         	[bookmark: pgfId-8159345]—
  
        
 
         
         	[bookmark: pgfId-8159347]HTTP_SERVERS
  
         	[bookmark: pgfId-8159349]customized default
  
         	[bookmark: pgfId-8159351]10.1.1.2
  
         	[bookmark: pgfId-8159353]—
  
        
 
         
         	[bookmark: pgfId-8159355]OTHER_SERVERS
  
         	[bookmark: pgfId-8159357]user-defined
  
         	[bookmark: pgfId-8159359]10.2.2.0/24
  
         	[bookmark: pgfId-8159361]—
  
        
 
         
         	[bookmark: pgfId-8159363]HOME_NET
  
         	[bookmark: pgfId-8159365]customized default
  
         	[bookmark: pgfId-8159367]10.1.1.0/24
OTHER_SERVERS
  
         	[bookmark: pgfId-8159369]SMTP_SERVERS
HTTP_SERVERS
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8154163]In the following example, HOME_NET is an invalid nested variable because the nesting of HOME_NET is circular; that is, the definition of OTHER_SERVERS includes HOME_NET, so you would be nesting HOME_NET in itself.
 
     [bookmark: pgfId-8156379]
 
      
       
        
        [bookmark: pgfId-8156332]Table 3-8 Example: An Invalid Nested Variable 
 
        
        
         
         	 
           
           [bookmark: pgfId-8156340]Variable. 
          
  
         	 
           
           [bookmark: pgfId-8156342]Type 
          
  
         	 
           
           [bookmark: pgfId-8156344]Included Networks 
          
  
         	 
           
           [bookmark: pgfId-8156346]Excluded Networks 
          
  
        
 
         
         	[bookmark: pgfId-8156348]SMTP_SERVERS
  
         	[bookmark: pgfId-8156350]customized default
  
         	[bookmark: pgfId-8156352]10.1.1.1
  
         	[bookmark: pgfId-8156354]—
  
        
 
         
         	[bookmark: pgfId-8156356]HTTP_SERVERS
  
         	[bookmark: pgfId-8156358]customized default
  
         	[bookmark: pgfId-8157738]10.1.1.2
  
         	[bookmark: pgfId-8156362]—
  
        
 
         
         	[bookmark: pgfId-8156364]OTHER_SERVERS
  
         	[bookmark: pgfId-8156366]user-defined
  
         	[bookmark: pgfId-8156368]10.2.2.0/24
HOME_NET
  
         	[bookmark: pgfId-8156370]—
  
        
 
         
         	[bookmark: pgfId-8156372]HOME_NET
  
         	[bookmark: pgfId-8156374]customized default
  
         	[bookmark: pgfId-8156376]10.1.1.0/24
OTHER_SERVERS
  
         	[bookmark: pgfId-8156378]SMTP_SERVERS
HTTP_SERVERS
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8156520]Because nested, negated variables are not supported, you cannot use the variable NONCORE_NET as shown in the following example to represent IP addresses that are outside of your protected networks.
 
      
      [bookmark: pgfId-8156707]Variable. 
     
 
      
      [bookmark: pgfId-8156709]Type 
     
 
      
      [bookmark: pgfId-8156711]Included Networks 
     
 
      
      [bookmark: pgfId-8156713]Excluded Networks 
     
 
     [bookmark: pgfId-8156715]HOME_NET
 
     [bookmark: pgfId-8156717]customized default
 
     [bookmark: pgfId-8156719]10.1.0.0/16
10.2.0.0/16
10.3.0.0/16
 
     [bookmark: pgfId-8156721]—
 
     [bookmark: pgfId-8156723]EXTERNAL_NET
 
     [bookmark: pgfId-8156725]customized default
 
     [bookmark: pgfId-8157790]—
 
     [bookmark: pgfId-8156729]HOME_NET
 
     [bookmark: pgfId-8156731]DMZ_NET
 
     [bookmark: pgfId-8156733]user-defined
 
     [bookmark: pgfId-8156735]10.4.0.0/16
 
     [bookmark: pgfId-8156737]—
 
     [bookmark: pgfId-8156739]NOTDMZ_NET
 
     [bookmark: pgfId-8156846]user-defined
 
     [bookmark: pgfId-8157852]—
 
     [bookmark: pgfId-8156745]DMZ_NET
 
     [bookmark: pgfId-8156825]NONCORE_NET
 
     [bookmark: pgfId-8157094]user-defined
 
     [bookmark: pgfId-8156829]EXTERNAL_NET
NOTDMZ_NET
 
     [bookmark: pgfId-8156831]—
 
    
 
     
      
       
       [bookmark: pgfId-8158474]Table 3-10 Example: Alternative to an Unsupported Nested, Negated Variable 
 
       
       
        
        	 
          
          [bookmark: pgfId-8158482]Variable. 
         
  
        	 
          
          [bookmark: pgfId-8158484]Type 
         
  
        	 
          
          [bookmark: pgfId-8158486]Included Networks 
         
  
        	 
          
          [bookmark: pgfId-8158488]Excluded Networks 
         
  
       
 
        
        	[bookmark: pgfId-8158490]HOME_NET
  
        	[bookmark: pgfId-8158492]customized default
  
        	[bookmark: pgfId-8158494]10.1.0.0/16
10.2.0.0/16
10.3.0.0/16
  
        	[bookmark: pgfId-8158496]—
  
       
 
        
        	[bookmark: pgfId-8158506]DMZ_NET
  
        	[bookmark: pgfId-8158508]user-defined
  
        	[bookmark: pgfId-8158510]10.4.0.0/16
  
        	[bookmark: pgfId-8158512]—
  
       
 
        
        	[bookmark: pgfId-8158522]NONCORE_NET
  
        	[bookmark: pgfId-8158524]user-defined
  
        	[bookmark: pgfId-8158526]—
  
        	[bookmark: pgfId-8158528]HOME_NET
DMZ_NET
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-8156750][bookmark: 43090]Linking Variable Sets to Intrusion Policies[bookmark: marker-8156749]
 
    [bookmark: pgfId-7795407]License: Protection
 
    [bookmark: pgfId-7795411]By default, the FireSIGHT System links the default variable set to all intrusion policies used in an access control policy. When you apply an access control policy that uses an intrusion policy, intrusion rules that you have enabled in the intrusion policy use the variable values in the linked variable set. 
 
    [bookmark: pgfId-8104412]When you modify a custom variable set used by an intrusion policy in an access control policy, the system reflects the status for that policy as out-of-date on the Access Control Policy page. You must reapply the access control policy to implement changes in your variable set. When you modify the default set, the system reflects the status of all access control policies that use intrusion policies as out-of-date, and you must reapply all access control policies to implement your changes.
 
    [bookmark: pgfId-7795412]See the following sections for information:
 
     
     	 [bookmark: pgfId-8079548]To link a variable set other than the default set to an access control rule, see the procedure in Configuring an Access Control Rule to Perform Intrusion Prevention.
 
     	 [bookmark: pgfId-8079553]To link a variable set other than the default set to the default action of an access control policy, see Setting Default Handling and Inspection for Network Traffic.
 
     	 [bookmark: pgfId-7795421]To apply access control policies, including policies that link variable sets to intrusion policies, see Applying an Access Control Policy.
 
    
 
   
 
    
     [bookmark: pgfId-7620609][bookmark: 86060]Understanding [bookmark: marker-7620608]Advanced Vari[bookmark: marker-7843277]ables
 
    [bookmark: pgfId-7620613]License: Protection
 
    [bookmark: pgfId-7620614]Advanced variables allow you to configure features that you cannot otherwise configure via the web interface. The FireSIGHT System currently provides only two advanced variables, and you can only edit the USER_CONF advanced variable.
 
    [bookmark: pgfId-7620618]USER_CONF
 
    [bookmark: pgfId-7620619]USER_CONF provides a general tool that allows you to configure one or more features not otherwise available via the web interface.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7620620] 
     Caution Do 
     not use the advanced variable USER_CONF to configure an intrusion policy feature unless you are instructed to do so in the feature description or by Support. Conflicting or duplicate configurations will halt the system. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7686089]When editing USER_CONF, you can type up to 4096 total characters on a single line; the line wraps automatically. You can include any number of valid instructions or lines until you reach the 8192 maximum character length for a variable or a physical limit such as disk space. Use the backslash (\) line continuation character after any complete argument in a command directive. 
 
    [bookmark: pgfId-7686090]Resetting USER_CONF empties it.
 
    [bookmark: pgfId-7686091]SNORT_BPF
 
    [bookmark: pgfId-7620626]SNORT_BPF is a legacy advanced variable that appears only when it was configured on your system in a FireSIGHT System software release before Version 5.3.0 that you subsequently upgraded to Version 5.3.0 or greater. You can only view or delete this variable. You cannot edit it or recover it after deleting it.
 
    [bookmark: pgfId-7620627]This variable allowed you to apply a Berkeley Packet Filter (BPF) to filter traffic before it reached the system. You should now use access control rules instead of this variable to enforce the filtering once offered by SNORT_BPF. This variable appears only with configurations that existed before system upgrade.
 
   
 
    
     [bookmark: pgfId-7620764][bookmark: 98873]Working with File [bookmark: marker-7846078]Lists
 
    [bookmark: pgfId-7620768]License: Malware
 
    [bookmark: pgfId-8108109]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-7620776]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-7620779]If you use network-based advanced mal[bookmark: marker-7620778]ware protection (AMP), and the Collective Security Intelligence Cloud incorrectly identifies a file’s disposition, you can add the file to a file list using a SHA-256 hash value to better detect the file in the future. Depending on the type of file list, you can do the following:
 
     
     	 [bookmark: pgfId-7843887]To treat a file as if the cloud assigned a clean disposition, add the file to the  clean list [bookmark: marker-7846242].
 
     	 [bookmark: pgfId-7843888]To treat a file as if the cloud assigned a malware disposition, add the file to the  custom detection list. [bookmark: marker-7846251]
 
    
 
    [bookmark: pgfId-7620785]Because you manually specify the blocking behavior for these files, the system does not perform malware cloud lookups, even if the files are otherwise identified as malware by the cloud. Note that you must configure a rule in the file policy with either a Malware Cloud Lookup or Block Malware action and a matching file type to calculate a file’s SHA value. For more information, see Working with File Rules. 
 
    [bookmark: pgfId-7620789]The system’s clean list and custom detection list are included by default in every file policy. You can opt not to use either or both lists on a per-policy basis. 
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7620790] 
     Caution Do 
     not include files on this list that are actually malware. The system does not block them, even if the cloud assigned the file’s a Malware disposition, or if you added the file to the custom detection list. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7620791]Each file list can contain up to 10000 unique SHA-256 values. To add files to the file list, you can:
 
     
     	 [bookmark: pgfId-7620792]use the event viewer context menu to add a SHA-256 value. 
 
     	 [bookmark: pgfId-7620793]upload a file so the system calculates and adds the file’s SHA-256 value.
 
     	 [bookmark: pgfId-7620794]enter a file’s SHA-256 value directly.
 
     	 [bookmark: pgfId-7620795]create and upload a comma-separated value (CSV) source file containing multiple SHA-256 values. All non-duplicate SHA-256 values are added to the file list.
 
    
 
    [bookmark: pgfId-7620796]When you add a file to a file list, edit a SHA-256 value in the file list, or delete SHA-256 values from the file list, you must reapply any access control policies with file policies that use the list for the changes to take effect. 
 
    [bookmark: pgfId-7620797]Because adding a file to a file list affects access control, you must have one of the following to manage all aspects of a file list:
 
     
     	 [bookmark: pgfId-7620798]Administrator access
 
     	 [bookmark: pgfId-7620799]a combination of Network Admin or Access Admin access (to edit the file list), Security Approver access (to reapply access control policies), and Security Analyst or Security Analyst (RO) access (to add a file using the SHA-256 value from the event view)
 
     	 [bookmark: pgfId-7620800]a custom role with Modify Access Control Policy and Object Manager (to edit the file list), Apply Access Control Policy (to reapply access control policies), and Modify File Events (to add a file using the SHA-256 value from the event view) permissions; see Managing Your Deployment with Custom User Roles 
 
    
 
    [bookmark: pgfId-7620804]For more information on using file lists, see the following topics:
 
     
     	 [bookmark: pgfId-7620808]Using the Context Menu
 
     	 [bookmark: pgfId-7620812]Uploading Multiple SHA-256 Values to a File List
 
     	 [bookmark: pgfId-7620816]Uploading an Individual File to a File List
 
     	 [bookmark: pgfId-7620820]Adding a SHA-256 Value to the File List
 
     	 [bookmark: pgfId-7620824]Modifying Files on a File List
 
     	 [bookmark: pgfId-7620828]Downloading a Source File from a File List
 
    
 
     
      [bookmark: pgfId-7620865][bookmark: 16834]Uploading [bookmark: marker-7846256]Multiple SHA-256 Values to a File List
 
     [bookmark: pgfId-7620869]License: Malware
 
     [bookmark: pgfId-8108129]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-7620877]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-7620879]You can add multiple SHA-256 values to a file list by uploading a comma-separated value (CSV) source file containing a list of SHA-256 values and descriptions. The Defense Center validates the contents and populates the file list with valid SHA-256 values.
 
     [bookmark: pgfId-7620883]The source file must be a simple text file with a .csv file name extension. Any header must start with a pound sign (#); it is treated as a comment and not uploaded. Each entry should contain a single SHA-256 value followed by a description of up to 256 alphanumeric or special characters and end with either the LF or CR+LF Newline character. The system ignores any additional information in the entry.
 
     [bookmark: pgfId-7620884]Note the following:
 
      
      	 [bookmark: pgfId-7620885]Deleting a source file from the file list also removes all associated SHA-256 hashes from the file list.
 
      	 [bookmark: pgfId-7620886]You cannot upload multiple files to a file list if the successful source file upload results in the file list containing more than 10000 distinct SHA-256 values.
 
      	 [bookmark: pgfId-7620887]The system truncates descriptions exceeding 256 characters to the first 256 characters on upload. If the description contains commas, you must use an escape character ( \, ). If no description is included, the source file name is used instead.
 
      	 [bookmark: pgfId-7620888]If a file list contains a SHA-256 value, and you upload a source file containing that value, the newly uploaded value does not modify the existing SHA-256 value. When viewing captured files, file events, or malware events related to the SHA-256 value, any threat name or description is derived from the individual SHA-256 value.
 
      	 [bookmark: pgfId-7620889]The system does not upload invalid SHA-256 values in a source file.
 
      	 [bookmark: pgfId-7831400]If multiple uploaded source files contain an entry for the same SHA-256 value, the system uses the most recent value.
 
      	 [bookmark: pgfId-7620890]If a source file contains multiple entries for the same SHA-256 value, the system uses the last one. 
 
      	 [bookmark: pgfId-7620891]You cannot directly edit a source file within the object manager. To make changes, you must first modify your source file directly, delete the copy on the system, then upload the modified source file. See Downloading a Source File from a File List for more information. 
 
     
 
     [bookmark: pgfId-7620895]To upload a source file to a file list:
 
     [bookmark: pgfId-8136512]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-8136513]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8136514]The Object Management page appears.
 
     [bookmark: pgfId-7620899]Step 2 Click File List.
 
     [bookmark: pgfId-7620900]The File List section appears.
 ) next to the file list where you want to add values from a source file. 
     
 
     [bookmark: pgfId-7620905]The File List pop-up window appears.
 
     [bookmark: pgfId-7620910]Step 4 Select List of SHAs from the Add by field.
 
     [bookmark: pgfId-7620911]The pop-up window updates to include new fields.
 
     [bookmark: pgfId-7620916]Step 5 Optionally, enter a description of the source file in the Description field. 
 
     [bookmark: pgfId-8139311]If you do not enter a description, the system uses the file name.
 
     [bookmark: pgfId-8139312]Step 6 Click Browse to browse to the source file, then click Upload and Add List to add the list.
 
     [bookmark: pgfId-8139313]The source file is added to the file list. The SHA-256 column lists how many SHA-256 values the file contains.
 
     [bookmark: pgfId-7620920]Step 7 Click Save. 
 
     [bookmark: pgfId-7620921]Step 8 Reapply all access control policies with file policies that use the file list.
 
     [bookmark: pgfId-7620922]After the policies apply, the system no longer performs malware cloud lookups on files in the file list.
 
     [bookmark: pgfId-7995511]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7620924][bookmark: 28463]Uploading an [bookmark: marker-7846282]Individual File to a File List
 
     [bookmark: pgfId-7620928]License: Malware
 
     [bookmark: pgfId-8108153]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-7620936]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-7620938]If you have a [bookmark: marker-7620937]copy of the file you want to add to a file list, you can upload the file to the Defense Center for analysis; the system calculates the file’s SHA-256 value and adds the file to the list. The system does not enforce a limit on the size of files for SHA-256 calculation. 
 
     [bookmark: pgfId-7620945]To add a file by having the Defense Center calculate its SHA-256 value:
 
     [bookmark: pgfId-7620946]Access: Admin/Network Admin
 
     
 ) next to the clean list or custom detection list where you want to add a file. 
     
 
     [bookmark: pgfId-7620951]The File List pop-up window appears.
 
     [bookmark: pgfId-7620956]Step 2 Select Calculate SHA from the Add by field.
 
     [bookmark: pgfId-7620957]The pop-up window updates to include new fields.
 
     [bookmark: pgfId-7620962]Step 3 Optionally, enter a description of the file in the Description field. 
 
     [bookmark: pgfId-7620963]If you do not enter a description, the file name is used for the description on upload.
 
     [bookmark: pgfId-7620964]Step 4 Click Browse to browse to the source file, then click Calculate and Add SHA to add the list.
 
     [bookmark: pgfId-7620965]The file is added to the file list.
 
     [bookmark: pgfId-7620966]Step 5 Click Save. 
 
     [bookmark: pgfId-7620967]Step 6 Reapply all access control policies with file policies that use the file list.
 
     [bookmark: pgfId-7620968]After the policies apply, the system no longer performs malware cloud lookups on files in the file list.
 
     [bookmark: pgfId-7995531]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7620970][bookmark: 14164]Adding a SHA-256 Value to the [bookmark: marker-7846315]File List
 
     [bookmark: pgfId-7620974]License: Malware
 
     [bookmark: pgfId-8108173]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-7620982]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-7620984]You can submit a file’s SHA-256 v[bookmark: marker-7620983]alue to add it to a file list. You cannot add duplicate SHA-256 values.
 
      
       
     
 
     
 
     [bookmark: pgfId-7620985]Tip Right-click a file or malware event from the event view and select Show Full Text in the context menu to view and copy the full SHA-256 value for the file.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7620986]To add a file by manually entering the file’s SHA-256 value:
 
     [bookmark: pgfId-7620987]Access: Admin/Network Admin
 
     
 ) next to the clean list or custom detection list where you want to add a file. 
     
 
     [bookmark: pgfId-7620992]The File List pop-up window appears.
 
     [bookmark: pgfId-7620997]Step 2 Select Enter SHA Value from the Add by field.
 
     [bookmark: pgfId-7620998]The pop-up window updates to include new fields.
 
     [bookmark: pgfId-7621003]Step 3 Enter a description of the source file in the Description field. 
 
     [bookmark: pgfId-7621004]Step 4 Type or paste the file’s entire SHA-256 value. The system does not support matching partial values.
 
     [bookmark: pgfId-7621005]Step 5 Click Add to add the file.
 
     [bookmark: pgfId-7621006]The file is added to the file list. 
 
     [bookmark: pgfId-7621007]Step 6 Click Save. 
 
     [bookmark: pgfId-7621008]Step 7 Reapply all access control policies with file policies that use the file list.
 
     [bookmark: pgfId-7621009]After the policies apply, the system no longer performs malware cloud lookups on files in the file list.
 
     [bookmark: pgfId-7995591]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7621011][bookmark: 71416]Modifying Files on a [bookmark: marker-7846347]File List
 
     [bookmark: pgfId-7621015]License: Malware
 
     [bookmark: pgfId-8108197]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-7621023]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-7621025]You can e[bookmark: marker-7621024]dit or delete individual SHA-256 values on a file list. Note that you cannot directly edit a source file within the object manager. To make changes, you must first modify your source file directly, delete the copy on the system, then upload the modified source file. See Downloading a Source File from a File List for more information. To edit a file on a file list:
 
     [bookmark: pgfId-7621029]Access: Admin/Network Admin
 
     
 ) next to the clean list or custom detection list where you want to modify a file. 
     
 
     [bookmark: pgfId-7621034]The File List pop-up window appears.
 ). 
     
 
     [bookmark: pgfId-7621043]The Edit SHA-256 pop-up window appears.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7621052]Step 3 Update the SHA-256 value or Description. 
 
    [bookmark: pgfId-7621053]Step 4 Click Save.
 
    [bookmark: pgfId-7621054]The File List pop-up window appears. The system updates the file entry in the list.
 
    [bookmark: pgfId-7621055]Step 5 Click Save. 
 
    [bookmark: pgfId-7621056]Step 6 Reapply all access control policies with file policies that use the file list.
 
    [bookmark: pgfId-7621057]After the policies apply, the system no longer performs malware cloud lookups on files in the file list.
 
    [bookmark: pgfId-7995603]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7621059][bookmark: 38522]Downloading a Source File from a [bookmark: marker-7846384]File List
 
    [bookmark: pgfId-7621063]License: Malware
 
    [bookmark: pgfId-8108221]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-7621071]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-7621072]You can view, download, or delete existing source file entries on a file list. Note that you cannot edit a source file once uploaded. You must first delete the source file from the file list, then upload an updated file. For more information on uploading a source file, see Uploading Multiple SHA-256 Values to a File List.
 
    [bookmark: pgfId-7621076]The number of entries associated with a source file refers to the number of distinct SHA-256 values. If you delete a source file from a file list, the total number of SHA-256 entries the file list contains decreases by the number of valid entries in the source file.
 
    [bookmark: pgfId-7621077]To download a source file:
 
    [bookmark: pgfId-7621078]Access: Admin/Network Admin
 
    
 ) next to the clean list or custom detection list where you want to download a source file. 
    
 
    [bookmark: pgfId-7621083]The File List pop-up window appears.
 ). 
    
 
    [bookmark: pgfId-7621092]The View SHA-256’s in list pop-up window appears.
 
    [bookmark: pgfId-7621097]Step 3 Click Download SHA List and follow the prompts to save the source file. 
 
    [bookmark: pgfId-7621098]Step 4 Click Close.
 
    [bookmark: pgfId-7621099]The File List pop-up window appears.
 
    [bookmark: pgfId-7995640]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7621103][bookmark: 11391]Working with Secu[bookmark: marker-7621101]rity Zones
 
    [bookmark: pgfId-7621104]License: Any
 
    [bookmark: pgfId-7621107]A security zone is a grouping of one or more inline, passive, switched, routed, or ASA interfaces that you can use to manage and classify traffic flow in various policies and configurations. The interfaces in a single zone may span multiple devices; you can also configure multiple zones on a single device. This allows you to divide the network into segments where you can apply various policies. You must assign at least one interface to a security zone to match traffic against that security zone, and each interface can belong to only one zone.
 
    [bookmark: pgfId-7621108]In addition to using security zones to group interfaces, you can use zones in various places in the system’s web interface, including access control policies, network discovery rules, and event searches. For example, you could write an access control rule that applies only to a specific source or destination zone, or restrict network discovery to traffic to or from a specific zone.
 
    [bookmark: pgfId-7621109]When you update a security zone object, the system saves a new revision of the object. As a result, if you have managed devices in the same security zone that have different revisions of the security zone object, you may log what appear to be duplicate connections. If you notice duplicate connection reporting, you can update all managed devices to use the same revision of the object. In the object manager, edit the security zone, remove all managed devices, save the object, re-add the managed devices, and save the object again. Then, reapply all affected device policies. For more information on applying device policies, see Applying Changes to Devices. 
 
    [bookmark: pgfId-7621113]You create security zones in one of the following ways:
 
     
     	 [bookmark: pgfId-7621114]The system creates security zones upon device registration, depending on the detection mode you selected for the device during its initial configuration. For example, the system creates a Passive zone in passive deployments, while in inline deployments the system creates External and Internal zones.
 
     	 [bookmark: pgfId-8136699]You can create security zones on the fly while configuring interfaces on a managed device.
 
     	 [bookmark: pgfId-8136700]You can create security zones using the object manager ( Objects > Object Management ).
 
    
 
    [bookmark: pgfId-8136701]The Security Zones page of the object manager lists the zones configured on your managed devices. The page also displays the type of interfaces in each zone, and you can expand each zone to view which interfaces on which devices belong to each zone.
 
     
      
    
 
    
 
    [bookmark: pgfId-7621122]Note All interfaces in a security zone must be of the same type, that is, all inline, passive, switched, routed, or ASA. Further, after you create a security zone, you cannot change the type of interfaces it contains.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7621123]If you modify your ASA security contexts, switching from single context mode to multi-context mode or visa versa, the system removes all interfaces from your security zone configurations.
 
    [bookmark: pgfId-8105145]You cannot delete a security zone that is in use. After you add or remove interfaces from a zone, you must reapply the device configuration to the devices where the interfaces reside. You must also reapply the access control and network discovery policies that use the zone.
 
    [bookmark: pgfId-7621124]To add a security zone:
 
    [bookmark: pgfId-7621125]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-7621126]Step 1 Select Objects > Object Management.
 
    [bookmark: pgfId-7621127]The Object Management page appears.
 
    [bookmark: pgfId-8139485]Step 2 Select Security Zones.
 
    [bookmark: pgfId-8139486]Step 3 Click Add Security Zone.
 
    [bookmark: pgfId-8139510]The Security Zones pop-up window appears.
 
    [bookmark: pgfId-8139511]Step 4 Type a Name for the zone. You can use any printable standard ASCII characters except curly braces ({}), a pipe (|), a semicolon (;), or the pound sign (#).
 
    [bookmark: pgfId-7621136]Step 5 Select an interface Type for the zone.
 
    [bookmark: pgfId-7621137]After you create a security zone, you cannot change its type.
 
    [bookmark: pgfId-7621139]Step 6 [bookmark: 48862]From the Device > Interfaces drop-down list, select a device that contains interfaces you want to add to the zone.
 
    [bookmark: pgfId-7621140]Step 7 Select one or more interfaces.
 
    [bookmark: pgfId-7621141]Use the Shift and Ctrl keys to select multiple objects. If you have not yet configured interfaces on your managed devices, you can create an empty zone and add interfaces to it later; skip to step 10.
 
    [bookmark: pgfId-7621146]Step 8 [bookmark: 56852]Click Add.
 
    [bookmark: pgfId-7621147]The interfaces you selected are added to the zone, grouped by device.
 
    [bookmark: pgfId-7621154]Step 9 Repeat steps 6 through 8 to add interfaces on other devices to the zone.
 
    [bookmark: pgfId-7621156]Step 10 [bookmark: 32416]Click Save.
 
    [bookmark: pgfId-7621157]The security zone is added.
 
    [bookmark: pgfId-7995651]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8059607][bookmark: 25469]Working with Cipher [bookmark: marker-8059606]Suite Lists
 
    [bookmark: pgfId-8059614]License: Any
 
    [bookmark: pgfId-8059621]Supported Devices: Series 3
 
    [bookmark: pgfId-8059631]A cipher suite list is an object comprised of several cipher suites. Each pre-defined cipher suite value represents a cipher suite used to negotiate an SSL- or TLS-encrypted session. You can use cipher suites and cipher suite lists in SSL rules to control encrypted traffic based on whether the client and server negotiated the SSL session using that cipher suite. If you add a cipher suite list to an SSL rule, SSL sessions negotiated with any of the cipher suites in the list match the rule.
 
     
      
    
 
    
 
    [bookmark: pgfId-8059632]Note Although you can use cipher suites in the web interface in the same places as cipher suite lists, you cannot add, modify, or delete cipher suites.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8059633]You cannot delete a cipher suite list that is in use. Additionally, after you edit a cipher suite list used in an SSL policy, you must reapply the associated access control policy for your changes to take effect. 
 
    [bookmark: pgfId-8059634]To create a cipher suite list:
 
    [bookmark: pgfId-8059638]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-8059639]Step 1 Select Objects > Object Management.
 
    [bookmark: pgfId-8139563]The Object Management page appears.
 
    [bookmark: pgfId-8139564]Step 2 Select Cipher Suite List.
 
    [bookmark: pgfId-8139565]Step 3 Click Add Cipher Suites.
 
    [bookmark: pgfId-8059643]The Cipher Suite List pop-up window appears.
 
    [bookmark: pgfId-8059644]Step 4 Type a Name for the cipher suite list. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-8059645]Step 5 Select one or more cipher suites and click Add.
 
     
      
      	 [bookmark: pgfId-8059646]Use Shift and Ctrl to select multiple cipher suites, or right-click and  Select All . 
 
      	 [bookmark: pgfId-8059650]Use the filter field (
 
     
 
     [image: ] ) to search for existing cipher suites to include, which updates as you type to display matching items. Click the reload icon ( 
     [image: ] ) above the search field or click the clear icon ( 
     [image: ] ) in the search field to clear the search string. 
    
 
    [bookmark: pgfId-8059657]Step 6 Click Save.
 
    [bookmark: pgfId-8059658]The cipher suite list is created.
 
    [bookmark: pgfId-8059659]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8059663][bookmark: 88375]Working with Distinguished [bookmark: marker-8059662]Name Objects
 
    [bookmark: pgfId-8059670]License: Any
 
    [bookmark: pgfId-8059677]Supported Devices: Series 3
 
    [bookmark: pgfId-8059687]Each distinguished name object represents the distinguished name listed for a public key certificate’s subject or issuer. You can use distinguished name objects and groups (see Grouping Objects) in SSL rules to control encrypted traffic based on whether the client and server negotiated the SSL session using a server certificate with the distinguished name as subject or issuer. 
 
    [bookmark: pgfId-8059691]Your distinguished name object can contain the common name attribute (CN). If you add a common name without “CN=” then the system prepends “CN=” before saving the object. 
 
     
      
       
       [bookmark: pgfId-8059695]Table 3-11 [bookmark: 51641]Distinguished Name Attributes
 
       
       
        
        	 
          
          [bookmark: pgfId-8059701]Attribute 
         
  
        	 
          
          [bookmark: pgfId-8059703]Description 
         
  
        	 
          
          [bookmark: pgfId-8059705]Allowed Values 
         
  
       
 
        
        	[bookmark: pgfId-8059707]C
  
        	[bookmark: pgfId-8059709]Country Code
  
        	[bookmark: pgfId-8059711]two alphabetic characters
  
       
 
        
        	[bookmark: pgfId-8059713]CN
  
        	[bookmark: pgfId-8059715]Common Name
  
        	 [bookmark: pgfId-8059717]up to 64 alphanumeric, backslash (/), hyphen (-), quotation ("), or asterisk (*) characters, or spaces
  
       
 
        
        	[bookmark: pgfId-8059720]O
  
        	[bookmark: pgfId-8059722]Organization
  
       
 
        
        	[bookmark: pgfId-8059726]OU
  
        	[bookmark: pgfId-8059728]Organizational Unit
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8059732]You can define one or more asterisks (*) as wild cards in an attribute. In a common name attribute, you can define one or more asterisks per domain name label. Wild cards match only within that label, though you can define multiple labels with wild cards. See the following table for examples.
 
    [bookmark: pgfId-8117453]
 
     
      
       
       [bookmark: pgfId-8117487]Table 3-12 Common Name Attribute Wild Card Examples
 
       
       
        
        	 
          
          [bookmark: pgfId-8117493]Attribute 
         
  
        	 
          
          [bookmark: pgfId-8117495]Matches 
         
  
        	 
          
          [bookmark: pgfId-8117497]Does Not Match 
         
  
       
 
        
        	[bookmark: pgfId-8117505]CN=”*ample.com”
  
        	[bookmark: pgfId-8117507]example.com
  
        	[bookmark: pgfId-8117509]mail.example.com
 [bookmark: pgfId-8118579]example.text.com
 [bookmark: pgfId-8118286]ampleexam.com
  
       
 
        
        	[bookmark: pgfId-8117511]CN=”exam*.com”
  
        	[bookmark: pgfId-8117513]example.com
  
        	[bookmark: pgfId-8117515]mail.example.com
 [bookmark: pgfId-8118549]example.text.com
 [bookmark: pgfId-8118075]ampleexam.com
  
       
 
        
        	[bookmark: pgfId-8117517]CN=”*xamp*.com”
  
        	[bookmark: pgfId-8117519]example.com
  
        	[bookmark: pgfId-8117521]mail.example.com
 [bookmark: pgfId-8118519]example.text.com
 [bookmark: pgfId-8118099]ampleexam.com
  
       
 
        
        	[bookmark: pgfId-8117523]CN=”*.example.com”
  
        	[bookmark: pgfId-8117525]mail.example.com
  
        	[bookmark: pgfId-8117527]example.com
 [bookmark: pgfId-8118459]example.text.com
 [bookmark: pgfId-8118171]ampleexam.com
  
       
 
        
        	[bookmark: pgfId-8118706]CN=”*.com”
  
        	[bookmark: pgfId-8118708]example.com
 [bookmark: pgfId-8118709]ampleexam.com
  
        	[bookmark: pgfId-8118711]mail.example.com
 [bookmark: pgfId-8118712]example.text.com
  
       
 
        
        	[bookmark: pgfId-8117529]CN=”*.*.com”
  
        	[bookmark: pgfId-8117531]mail.example.com
 [bookmark: pgfId-8118489]example.text.com
  
        	[bookmark: pgfId-8117533]example.com
 [bookmark: pgfId-8118249]ampleexam.com
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8117174]You cannot delete a distinguished name object that is in use. Additionally, after you edit a distinguished name object used in an SSL policy, you must reapply the associated access control policy for your changes to take effect.
 
    [bookmark: pgfId-8059733]To add a distinguished name object:
 
    [bookmark: pgfId-8139658]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-8139659]Step 1 Select Objects > Object Management.
 
    [bookmark: pgfId-8139660]The Object Management page appears.
 
    [bookmark: pgfId-8059740]Step 2 Under Distinguished Name, select Individual Objects.
 
    [bookmark: pgfId-8059741]Step 3 Click Add Distinguished Name.
 
    [bookmark: pgfId-8059742]The Distinguished Name pop-up window appears.
 
    [bookmark: pgfId-8059743]Step 4 Type a Name for the distinguished name object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-8059744]Step 5 In the DN field, type a value for the distinguished name or common name. You have the following options:
 
     
      
      	 [bookmark: pgfId-8059748]If you add a distinguished name, you can include one of each attribute listed in Table 3-11 separated by commas. 
 
      	 [bookmark: pgfId-8065607]If you add a common name, you can include multiple labels and wild cards.
 
     
 
    
 
    [bookmark: pgfId-8059749]Step 6 Click Save.
 
    [bookmark: pgfId-8059750]The distinguished name object is added.
 
    [bookmark: pgfId-8059751]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8059754][bookmark: 71963]Working with PKI [bookmark: marker-8059753]Objects
 
    [bookmark: pgfId-8059761]License: Any
 
    [bookmark: pgfId-8059768]Supported Devices: Series 3
 
    [bookmark: pgfId-8059777]PKI objects represent the public key certificates and paired private keys required to support your SSL inspection deployment. Internal and trusted CA objects consist of certificate authority (CA) certificates; internal CA objects also contain the private key paired with the certificate. Internal and external certificate objects consist of server certificates; internal certificate objects also contain the private key paired with the certificate. Using these objects in SSL rules, you can decrypt:
 
     
     	 [bookmark: pgfId-8059778]outgoing traffic by re-signing the server certificate with an internal CA object
 
     	 [bookmark: pgfId-8059779]incoming traffic using the known private key in an internal certificate object
 
    
 
    [bookmark: pgfId-8059780]You can also create SSL rules and match traffic encrypted with:
 
     
     	 [bookmark: pgfId-8059781]the certificate in an external certificate object
 
     	 [bookmark: pgfId-8059782]a certificate either signed by the CA in a trusted CA object, or within the CA’s chain of trust
 
    
 
    [bookmark: pgfId-8059783]You can manually input certificate and key information, upload a file containing that information, or in some cases, generate a new CA certificate and private key.
 
    [bookmark: pgfId-8059784]When you view a list of PKI objects in the object manager, the system displays the certificate’s Subject distinguished name as the object value. Hover your pointer over the value to view the full certificate Subject distinguished name. To view other certificate details, edit the PKI object.
 
     
      
    
 
    
 
    [bookmark: pgfId-8059788]Note The Defense Center and managed devices encrypt all private keys stored in internal CA objects and internal certificate objects with a randomly generated key before saving them. If you upload private keys that are password protected, the appliance decrypts the key using the user-supplied password, then reencrypts it with the randomly generated key before saving it. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8059789]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-8059793]Working with Internal Certificate Authority Objects
 
     	 [bookmark: pgfId-8059797]Working with Trusted Certificate Authority Objects
 
     	 [bookmark: pgfId-8059801]Working with External Certificate Objects
 
     	 [bookmark: pgfId-8059805]Working with Internal Certificate Objects
 
    
 
     
      [bookmark: pgfId-8059808][bookmark: 49055]Working with Internal Certificate [bookmark: marker-8128252]Authority Objects
 
     [bookmark: pgfId-8059815]License: Any
 
     [bookmark: pgfId-8059822]Supported Devices: Series 3
 
     [bookmark: pgfId-8059832]Each internal certificate authority (CA) object you configure represents the CA public key certificate of a CA your organization controls. The object consists of the object name, CA certificate, and paired private key. You can use internal CA objects and groups (see Grouping Objects) in SSL rules to decrypt outgoing encrypted traffic by re-signing the server certificate with the internal CA.
 
      
       
     
 
     
 
     [bookmark: pgfId-8059836]Note If you reference an internal CA object in a Decrypt - Resign SSL rule and the rule matches an encrypted session, the user’s browser may warn that the certificate is not trusted while negotiating the SSL handshake. To avoid this, add the internal CA object certificate to either the client or domain list of trusted root certificates.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8059837]You can create an internal CA object in the following ways:
 
      
      	 [bookmark: pgfId-8059838]import an existing RSA-based or elliptic curve-based CA certificate and private key
 
      	 [bookmark: pgfId-8059839]generate a new self-signed RSA-based CA certificate and private key 
 
      	 [bookmark: pgfId-8059840]generate an unsigned RSA-based CA certificate and private key. You must submit a certificate signing request (CSR) to another CA to sign the certificate before using the internal CA object.
 
     
 
     [bookmark: pgfId-8059841]After you create an internal CA object containing a signed certificate, you can download the CA certificate and private key. The system encrypts downloaded certificates and private keys with a user-provided password. 
 
     [bookmark: pgfId-8059842]Whether system-generated or user-created, you can modify the internal CA object name, but cannot modify other object properties.
 
     [bookmark: pgfId-8059843]You cannot delete an internal CA object that is in use. Additionally, after you edit an internal CA object used in an SSL policy, the associated access control policy goes out-of-date. You must reapply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-8059844]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-8059848]Importing a CA Certificate and Private Key
 
      	 [bookmark: pgfId-8059852]Generating a New CA Certificate and Private Key
 
      	 [bookmark: pgfId-8059856]Obtaining and Uploading a New Signed Certificate
 
      	 [bookmark: pgfId-8059860]Downloading a CA Certificate and Private Key
 
     
 
    
 
     
      [bookmark: pgfId-8059863][bookmark: 68161]Importing a CA Certificate and [bookmark: marker-8128257]Private Key
 
     [bookmark: pgfId-8059870]License: Any
 
     [bookmark: pgfId-8059877]Supported Devices: Series 3
 
     [bookmark: pgfId-8059887]You can configure an internal CA object by importing an X.509 v3 CA certificate and private key. You can upload files encoded in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8059888]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8059889]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8059892]If the private key file is password-protected, you can supply the decryption password. If the certificate and key are encoded in the PEM format, you can also copy and paste the information. 
 
     [bookmark: pgfId-8076814]You can upload only files that contain proper certificate or key information, and that are paired with each other. The system validates the pair before saving the object.
 
      
       
     
 
     
 
     [bookmark: pgfId-8076815]Note If you configure a rule with the Decrypt - Resign action, the rule matches traffic based on the referenced internal CA certificate’s encryption algorithm type, in addition to any configured rule conditions. You must upload an elliptic curve-based CA certificate to decrypt outgoing traffic encrypted with an elliptic curve-based algorithm, for example. For more information, see Decrypt Actions: Decrypting Traffic for Further Inspection. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8076816]To import an internal CA certificate and private key:
 
     [bookmark: pgfId-8059898]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8059899]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8059900]The Object Management page appears.
 
     [bookmark: pgfId-8059901]Step 2 Under PKI, select Internal CAs.
 
     [bookmark: pgfId-8059902]Step 3 Click Import CA.
 
     [bookmark: pgfId-8059903]The Import Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8059904]Step 4 Type a Name for the internal CA object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8059905]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 CA certificate file. 
 
     [bookmark: pgfId-8059906]Step 6 Above the Key field, click Browse to upload a DER or PEM-encoded paired private key file.
 
     [bookmark: pgfId-8059907]Step 7 If the uploaded file is password-protected, select the Encrypted, and the password is: check box and enter the password.
 
     [bookmark: pgfId-8059908]Step 8 Click Save.
 
     [bookmark: pgfId-8059909]The internal CA object is added.
 
     [bookmark: pgfId-8059910]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8059913][bookmark: 90329]Generating a New CA Certificate and [bookmark: marker-8128262]Private Key
 
     [bookmark: pgfId-8059920]License: Any
 
     [bookmark: pgfId-8059927]Supported Devices: Series 3
 
      
       
        
        [bookmark: pgfId-8059941]Table 3-13 [bookmark: 57956]Generated Internal CA Attributes
 
        
        
         
         	 
           
           [bookmark: pgfId-8059947]Field 
          
  
         	 
           
           [bookmark: pgfId-8059949]Allowed Values 
          
  
         	 
           
           [bookmark: pgfId-8059951]Required 
          
  
        
 
         
         	[bookmark: pgfId-8059953]Country Name (two-letter code)
  
         	[bookmark: pgfId-8059955]two alphabetic characters
  
         	[bookmark: pgfId-8059957]yes
  
        
 
         
         	[bookmark: pgfId-8116896]State or Province
  
         	 [bookmark: pgfId-8059961]up to 64 alphanumeric, backslash (/), hyphen (-), quotation ("), asterisk (*), period (.), or space characters
  
         	 [bookmark: pgfId-8059963]no
  
        
 
         
         	[bookmark: pgfId-8059965]Locality or City
  
        
 
         
         	[bookmark: pgfId-8059971]Organization
  
        
 
         
         	[bookmark: pgfId-8059977]Organizational Unit
  
        
 
         
         	[bookmark: pgfId-8059983]Common Name
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8059989]The generated CA certificate is valid for ten years. The Valid From date is a week before generation. 
 
     [bookmark: pgfId-8059990]To generate a self-signed CA certificate:
 
     [bookmark: pgfId-8059994]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8059995]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8059996]The Object Management page appears.
 
     [bookmark: pgfId-8059997]Step 2 Under PKI, select Internal CAs.
 
     [bookmark: pgfId-8059998]Step 3 Click Generate CA.
 
     [bookmark: pgfId-8059999]The Generate Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8060000]Step 4 Type a Name for the internal CA object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8060004]Step 5 Type the identification attributes, as described in Table 3-13.
 
     [bookmark: pgfId-8060005]Step 6 Click Generate self-signed CA.
 
     [bookmark: pgfId-8060006]The internal CA object is added.
 
     [bookmark: pgfId-8060007]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8060009][bookmark: 28976]Obtaining and Uploading a New Signed Certificate
 
     [bookmark: pgfId-8060016]License: Any
 
     [bookmark: pgfId-8060023]Supported Devices: Series 3
 
     [bookmark: pgfId-8060032]You can configure an internal CA object by obtaining a signed certificate from a CA. This involves two steps: 
 
      
      	 [bookmark: pgfId-8060033]Provide identification information to configure the internal CA object. This generates an unsigned certificate and paired private key, and creates a certificate signing request (CSR) to a CA you specify. 
 
      	 [bookmark: pgfId-8060034]After the CA issues the signed certificate, upload it to the internal CA object, replacing the unsigned certificate. 
 
     
 
     [bookmark: pgfId-8060035]You can only reference an internal CA object in an SSL rule if it contains a signed certificate. 
 
     [bookmark: pgfId-8060036]To create an unsigned CA certificate and CSR:
 
     [bookmark: pgfId-8060040]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8060041]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8060042]The Object Management page appears.
 
     [bookmark: pgfId-8060043]Step 2 Under PKI, select Internal CAs.
 
     [bookmark: pgfId-8060044]Step 3 Click Generate CA.
 
     [bookmark: pgfId-8060045]The Generate Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8060046]Step 4 Type a Name for the internal CA object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8060050]Step 5 Type the identification attributes, as described in Table 3-13.
 
     [bookmark: pgfId-8060051]Step 6 Click Generate CSR.
 
     [bookmark: pgfId-8060052]The Generate Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8060053]Step 7 Copy the CSR to submit to a CA.
 
     [bookmark: pgfId-8060054]Step 8 Click OK. 
 
     [bookmark: pgfId-8060055]The CA object is created. Note that before you can use it, you must upload a signed certificate issued by a CA.
 
     [bookmark: pgfId-8060056]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8060057]To upload a signed certificate issued in response to a CSR:
 
     [bookmark: pgfId-8060061]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8060062]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8060063]The Object Management page appears.
 
     [bookmark: pgfId-8060064]Step 2 Under PKI, select Internal CAs.
 ) next to the CA object containing the unsigned certificate awaiting the CSR. 
     
 
     [bookmark: pgfId-8060069]The Edit Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8060070]Step 4 Click Install Certificate.
 
     [bookmark: pgfId-8060071]The Install Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8060072]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 CA certificate file. 
 
     [bookmark: pgfId-8060073]Step 6 If the uploaded file is password protected, select the Encrypted, and the password is: check box and enter the password.
 
     [bookmark: pgfId-8060074]Step 7 Click Save.
 
     [bookmark: pgfId-8060075]The CA object contains a signed certificate, and can be referenced in SSL rules.
 
     [bookmark: pgfId-8060076]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8060079][bookmark: 35953]Downloading a CA Certificate and [bookmark: marker-8128267]Private Key
 
     [bookmark: pgfId-8060086]License: Any
 
     [bookmark: pgfId-8060093]Supported Devices: Series 3
 
     [bookmark: pgfId-8060103]You can back up or transfer a CA certificate and paired private key by downloading a file containing the certificate and key information from an internal CA object.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8060104] 
      Caution Always store downloaded key information in a secure location. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8060105]The system encrypts the private key stored in an internal CA object with a randomly generated key before saving it to disk. If you download a certificate and private key from an internal CA object, the system first decrypts the information before creating a file containing the certificate and private key information. You must then provide a password the system uses to encrypt the downloaded file.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8060106] 
      Caution Private keys downloaded as part of a system backup are decrypted, then stored in the unencrypted backup file. For more information, see 
      Creating Backup Files. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8060110]To download an internal CA certificate and private key:
 
     [bookmark: pgfId-8060114]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8060115]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8060116]The Object Management page appears.
 
     [bookmark: pgfId-8060117]Step 2 Under PKI, select Internal CAs.
 ) next to the internal CA object whose certificate and private key you want to download. 
     
 
     [bookmark: pgfId-8060122]The Edit Internal Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8060123]Step 4 Click Download.
 
     [bookmark: pgfId-8060124]The Encrypt Download File pop-up window appears.
 
     [bookmark: pgfId-8060125]Step 5 Type an encryption password in the Password and Confirm Password fields.
 
     [bookmark: pgfId-8060126]Step 6 Click OK.
 
     [bookmark: pgfId-8060127]You are prompted to save the file.
 
     [bookmark: pgfId-8060128]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8060132][bookmark: 43848]Working with Trusted Certificate [bookmark: marker-8128272]Authority Objects
 
     [bookmark: pgfId-8060139]License: Any
 
     [bookmark: pgfId-8060146]Supported Devices: Series 3
 
     [bookmark: pgfId-8060157]Each trusted certificate authority (CA) object you configure represents a CA public key certificate belonging to a trusted CA outside your organization. The object consists of the object name and CA public key certificate. You can use external CA objects and groups (see Grouping Objects) in the SSL policy to control traffic encrypted with a certificate signed either by the trusted CA, or any CA within the chain of trust. 
 
     [bookmark: pgfId-8060161]After you create the trusted CA object, you can modify the name and add certificate revocation lists (CRL), but cannot modify other object properties. There is no limit on the number of CRLs you can add to an object. If you want to modify a CRL you have uploaded to an object, you must delete the object and recreate it. 
 
     [bookmark: pgfId-8060162]You cannot delete a trusted CA object that is in use. Additionally, after you edit a trusted CA object used in an SSL policy, the associated access control policy goes out-of-date. You must reapply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-8060163]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-8060167]Adding a Trusted CA Object
 
      	 [bookmark: pgfId-8060171]Adding a Certificate Revocation List to a Trusted CA Object
 
     
 
    
 
     
      [bookmark: pgfId-8060173][bookmark: 51004]Adding a [bookmark: marker-8128277]Trusted CA Object
 
     [bookmark: pgfId-8060180]License: Any
 
     [bookmark: pgfId-8060187]Supported Devices: Series 3
 
     [bookmark: pgfId-8060196]You can configure an external CA object by uploading an X.509 v3 CA certificate. You can upload a file encoded in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8060197]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8060198]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8060200]If the file is password-protected, you must supply the decryption password. If the certificate is encoded in the PEM format, you can also copy and paste the information. 
 
     [bookmark: pgfId-8060201]You can upload a CA certificate only if the file contains proper certificate information; the system validates the certificate before saving the object.
 
     [bookmark: pgfId-8060202]To import a trusted CA certificate:
 
     [bookmark: pgfId-8060206]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8060207]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8060208]The Object Management page appears.
 
     [bookmark: pgfId-8060209]Step 2 Under PKI, select Trusted CAs.
 
     [bookmark: pgfId-8060210]Step 3 Click Add Trusted CAs.
 
     [bookmark: pgfId-8060211]The Import Trusted Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8060212]Step 4 Type a Name for the trusted CA object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8060213]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 CA certificate file. 
 
     [bookmark: pgfId-8060214]Step 6 If the file is password-protected, select the Encrypted, and the password is: check box and enter the password.
 
     [bookmark: pgfId-8060215]Step 7 Click OK.
 
     [bookmark: pgfId-8060216]The trusted CA object is added.
 
     [bookmark: pgfId-8060217]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8060219][bookmark: 27054]Adding a Certificate Revocation List to a [bookmark: marker-8128282]Trusted CA Object
 
     [bookmark: pgfId-8060226]License: Any
 
     [bookmark: pgfId-8060233]Supported Devices: Series 3
 
     [bookmark: pgfId-8060242]You can upload CRLs to a trusted CA object. If you reference that trusted CA object in an SSL policy, you can control encrypted traffic based on whether the CA that issued the session encryption certificate subsequently revoked the certificate. You can upload files encoded in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8060243]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8060244]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8060245]After you add the CRL, you can view the list of revoked certificates. If you want to modify a CRL you have uploaded to an object, you must delete the object and recreate it.
 
     [bookmark: pgfId-8060246]You can upload only files that contain a proper CRL. There is no limit to the number of CRLs you can add to a trusted CA object. However, you must save the object each time you upload a CRL, before adding another CRL.
 
     [bookmark: pgfId-8060247]To upload a CRL:
 
     [bookmark: pgfId-8060251]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8060252]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8060253]The Object Management page appears.
 
     [bookmark: pgfId-8060254]Step 2 Under PKI, select Trusted CAs.
 ) next to a trusted CA object. 
     
 
     [bookmark: pgfId-8060259]The Edit Trusted Certificate Authority pop-up window appears.
 
     [bookmark: pgfId-8060260]Step 4 Click Add CRL to upload a DER or PEM-encoded CRL file.
 
     [bookmark: pgfId-8060261]Step 5 Click OK.
 
     [bookmark: pgfId-8060262]Your changes are saved.
 
     [bookmark: pgfId-8060263]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8060267][bookmark: 18936]Working with External Certificate [bookmark: marker-8128287]Objects
 
     [bookmark: pgfId-8060274]License: Any
 
     [bookmark: pgfId-8060281]Supported Devices: Series 3
 
     [bookmark: pgfId-8060292]Each external certificate object you configure represents a server public key certificate that does not belong to your organization. The object consists of the object name and certificate. You can use external certificate objects and groups (see Grouping Objects) in SSL rules to control traffic encrypted with the server certificate. For example, you can upload a self-signed server certificate that you trust, but cannot verify with a trusted CA certificate.
 
     [bookmark: pgfId-8060296]You can configure an external certificate object by uploading an X.509 v3 server certificate. You can upload a file in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8082592]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8082593]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8060299]You can upload only files that contains proper server certificate information; the system validates the file before saving the object. If the certificate is encoded in the PEM format, you can also copy and paste the information. 
 
     [bookmark: pgfId-8060300]After you create the external certificate object, you can modify the name, but cannot modify other object properties. 
 
     [bookmark: pgfId-8066182]You cannot delete an external certificate object that is in use. Additionally, after you edit an external certificate object used in an SSL policy, the associated access control policy goes out-of-date. You must reapply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-8060301]To add an external certificate object:
 
     [bookmark: pgfId-8137392]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8137393]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8137394]The Object Management page appears.
 
     [bookmark: pgfId-8060308]Step 2 Under PKI, select External Certs.
 
     [bookmark: pgfId-8060309]Step 3 Click Add External Cert.
 
     [bookmark: pgfId-8060310]The Add Known External Certificate pop-up window appears.
 
     [bookmark: pgfId-8060311]Step 4 Type a Name for the external certificate object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8060312]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 server certificate file. 
 
     [bookmark: pgfId-8060313]Step 6 Click Save.
 
     [bookmark: pgfId-8060314]The internal CA object is added.
 
     [bookmark: pgfId-8060315]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8060319][bookmark: 98828]Working with Internal Certificate [bookmark: marker-8128292]Objects
 
     [bookmark: pgfId-8060326]License: Any
 
     [bookmark: pgfId-8060333]Supported Devices: Series 3
 
     [bookmark: pgfId-8060344]Each internal certificate object you configure represents a server public key certificate belonging to your organization. The object consists of the object name, public key certificate, and paired private key. You can use internal certificate objects and groups (see Grouping Objects) in SSL rules to decrypt traffic incoming to one of your organization’s servers using the known private key.
 
     [bookmark: pgfId-8060348]You can configure an internal certificate object by uploading an X.509 v3 RSA-based or elliptic curve-based server certificate and paired private key. You can upload a file in one of the following supported formats:
 
      
      	 [bookmark: pgfId-8082812]Distinguished Encoding Rules (DER)
 
      	 [bookmark: pgfId-8082813]Privacy-enhanced Electronic Mail (PEM)
 
     
 
     [bookmark: pgfId-8060351]If the file is password-protected, you must supply the decryption password. If the certificate and key are encoded in the PEM format, you can also copy and paste the information.
 
     [bookmark: pgfId-8060352]You can upload only files that contain proper certificate or key information, and that are paired with each other. The system validates the pair before saving the object.
 
     [bookmark: pgfId-8060353]After you create the internal certificate object, you can modify the name, but cannot modify other object properties. 
 
     [bookmark: pgfId-8066192]You cannot delete an internal certificate object that is in use. Additionally, after you edit an internal certificate object used in an SSL policy, the associated access control policy goes out-of-date. You must reapply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-8060354]To add an internal certificate object:
 
     [bookmark: pgfId-8060358]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-8060359]Step 1 Select Objects > Object Management.
 
     [bookmark: pgfId-8140202]The Object Management page appears.
 
     [bookmark: pgfId-8140203]Step 2 Under PKI, select Internal Certs.
 
     [bookmark: pgfId-8140204]Step 3 Click Add Internal Cert.
 
     [bookmark: pgfId-8060363]The Add Known Internal Certificate pop-up window appears.
 
     [bookmark: pgfId-8060364]Step 4 Type a Name for the internal certificate object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-8060365]Step 5 Above the Certificate Data field, click Browse to upload a DER or PEM-encoded X.509 v3 server certificate file. 
 
     [bookmark: pgfId-8060366]Step 6 Above the Key field, or click Browse to upload a DER or PEM-encoded paired private key file.
 
     [bookmark: pgfId-8060367]Step 7 If the uploaded private key file is password-protected, select the Encrypted, and the password is: check box and enter the password.
 
     [bookmark: pgfId-8060368]Step 8 Click Save.
 
     [bookmark: pgfId-8060369]The internal certificate object is added.
 
     [bookmark: pgfId-8082840]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7859396][bookmark: 48697]Working[bookmark: marker-7859395] with Geolocation Objects
 
    [bookmark: pgfId-7621163]License: FireSIGHT
 
    [bookmark: pgfId-7621167]Supported Devices: Series 3, virtual, ASA FirePOWER
 
    [bookmark: pgfId-7621183]Supported Defense Centers: All except DC500
 
    [bookmark: pgfId-7806732]Each geolocation object you configure represents one or more countries or continents that the system has identified as the source or destination of traffic on your monitored network. You can use geolocation objects in various places in the system’s web interface, including access control policies, SSL policies, and event searches. For example, you could write an access control rule that blocks traffic to or from certain countries. For information on filtering traffic by geographical location, see Controlling Traffic by Network or Geographical Location. For information on filtering encrypted traffic by geographic location, see Controlling Encrypted Traffic by Network or Geographical Location.
 
    [bookmark: pgfId-7621188]To ensure that you are using up-to-date information to filter your network traffic, Cisco strongly recommends that you regularly update your Geolocation Database (GeoDB). For information on downloading and installing GeoDB updates, see Updating the Geolocation Database.
 
    [bookmark: pgfId-7621192]You cannot delete a geolocation object that is in use. Additionally, after you edit a geolocation object used in an access control policy or SSL policy, you must reapply the access control policy for your changes to take effect.
 
    [bookmark: pgfId-7621193]To add a geolocation object:
 
    [bookmark: pgfId-7621194]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-7621195]Step 1 Select Objects > Object Management.
 
    [bookmark: pgfId-7621196]The Object Management page appears.
 
    [bookmark: pgfId-7621197]Step 2 Select Geolocation.
 
    [bookmark: pgfId-7621198]The Geolocation Objects page appears.
 
    [bookmark: pgfId-7621199]Step 3 Click Add Geolocation.
 
    [bookmark: pgfId-7621200]The Geolocation Object pop-up window appears.
 
    [bookmark: pgfId-7621205]Step 4 Type a Name for the geolocation object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-7621206]Step 5 Select the check boxes for the countries and continents you want to include in your geolocation object. 
 
    [bookmark: pgfId-7806960]Selecting a continent selects all countries within that continent, as well as any countries that GeoDB updates may add under that continent in the future. Deselecting any country under a continent deselects the continent. You can select any combination of countries and continents.
 
    [bookmark: pgfId-7621207]Step 6 Click Save.
 
    [bookmark: pgfId-7621208]The geolocation object is added.
 
    [bookmark: pgfId-7995839]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7621209]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-6753877][bookmark: 40568]Managing Devices 
      
      
 
     
 
 
    [bookmark: pgfId-7283871]The Defense Center is a key component in the FireSIGHT System. You can use the Defense Center to manage the full range of devices that comprise the FireSIGHT System, and to aggregate, analyze, and respond to the threats they detect on your network.
 
    [bookmark: pgfId-7283881]By using the Defense Center to manage devices, you can:
 
     
     	 [bookmark: pgfId-7283882]configure policies for all your devices from a single location, making it easier to change configurations
 
     	 [bookmark: pgfId-7283883]install various types of software updates on devices
 
     	 [bookmark: pgfId-7283884]push health policies to your managed devices and monitor their health status from the Defense Center
 
    
 
    [bookmark: pgfId-8062813]The Defense Center aggregates and correlates intrusion events, network discovery information, and device performance data, allowing you to monitor the information that your devices are reporting in relation to one another, and to assess the overall activity occurring on your network.
 
    [bookmark: pgfId-8062814]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-7283896]Management Concepts describes some of the features and limitations involved with managing your devices with a Defense Center.
 
     	 [bookmark: pgfId-7963564]Understanding Management Interfaces describes how you can use traffic channels and multiple management interfaces to improve performance or isolate traffic between devices on different networks.
 
     	 [bookmark: pgfId-7283902]Working in NAT Environments describes the principles of setting up the management of your devices in Network Address Translation environments.
 
     	 [bookmark: pgfId-7294132]Configuring High Availability describes how to set up two Defense Centers as a high availability pair to help ensure continuity of operations.
 
     	 [bookmark: pgfId-8122734]Working with Devices describes how to establish and disable connections between devices and your Defense Center. It also explains how to add, delete, and change the state of managed devices.
 
     	 [bookmark: pgfId-8122745]Managing Device Groups describes how to create device groups as well as how to add and remove devices from groups.
 
     	 [bookmark: pgfId-7296032]Clustering Devices describes how to establish and manage high availability between two managed devices.
 
     	 [bookmark: pgfId-7295179]Editing Device Configuration describes the device attributes you can edit and explains how to edit them.
 
     	 [bookmark: pgfId-7465325]Managing Stacked Devices describes how to create a stack of managed devices and how to remove devices from a stack.
 
     	 [bookmark: pgfId-7293313]Configuring Sensing Interfaces explains how to configure interfaces on your managed devices.
 
    
 
   
 
    
     [bookmark: pgfId-7283033][bookmark: 51493]Management [bookmark: marker-7283032]Concepts
 
    [bookmark: pgfId-7283037]You can use a Defense Center to manage nearly every aspect of a device’s behavior. You need only one Defense Center to manage a device, though you can also use a second Defense Center as part of a high availability pair. The sections that follow explain some of the concepts you need to know as you plan your FireSIGHT System deployment:
 
     
     	 [bookmark: pgfId-7283050]What Can Be Managed by a Defense Center?
 
     	 [bookmark: pgfId-7283058]Beyond Policies and Events
 
     	 [bookmark: pgfId-7283062]Using Redundant Defense Centers
 
    
 
     
      [bookmark: pgfId-7283067][bookmark: 76620]What Can Be Managed by a Defense Center?
 
     [bookmark: pgfId-7788117]You can use your Defense Center as a central management point in a FireSIGHT System deployment to manage the following devices:
 
      
      	 [bookmark: pgfId-7788121]FirePOWER managed devices
 
      	 [bookmark: pgfId-7839729]Cisco ASA with FirePOWER Services devices
 
      	 [bookmark: pgfId-7821951]software-based devices, such as virtual devices and Cisco NGIPS for Blue Coat X-Series
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7821956]Note Cisco recommends than you manage no more than three devices (including software-based devices) with the DC500 model Defense Center. For details on DC500 database limitations see the Database Event Limits table.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7614698]When you manage a device, information is transmitted between the Defense Center and the device over a secure, SSL-encrypted TCP tunnel.
 
     [bookmark: pgfId-7438252]The following illustration lists what is transmitted between a Defense Center and its managed devices. Note that the types of events and policies that are sent between the appliances are based on the device type.
 
     [bookmark: pgfId-8232541]
 
      
      [image: ] 
     
 
      
       [bookmark: pgfId-7878150]
 
     
 
    
 
     
      [bookmark: pgfId-7878152][bookmark: 93949]Beyond Policies and Events
 
     [bookmark: pgfId-7878156]License: Any
 
     [bookmark: pgfId-7283379]In addition to applying policies to devices and receiving events from them, you can also perform other device-related tasks on the Defense Center.
 
     [bookmark: pgfId-7283383]Backing Up a Device
 
     [bookmark: pgfId-7283384]You cannot create or restore backup files for virtual managed devices, Cisco NGIPS for Blue Coat X-Series, or Cisco ASA with FirePOWER Services. 
 
     [bookmark: pgfId-8087926]When you perform a backup of a physical managed device from the device itself, you back up the device configuration only. To back up configuration data and, optionally, unified files, perform a backup of the device using the managing Defense Center.
 
     [bookmark: pgfId-8110007]To back up event data, perform a backup of the managing Defense Center. For more information, see Creating Backup Files.
 
     [bookmark: pgfId-7283408]Updating Devices
 
     [bookmark: pgfId-7283415]From time to time, Cisco releases updates to the FireSIGHT System, including:
 
      
      	 [bookmark: pgfId-7283419]intrusion rule updates, which may contain new and updated intrusion rules
 
      	 [bookmark: pgfId-7283420]vulnerability database updates
 
      	 [bookmark: pgfId-7618628]geolocation updates
 
      	 [bookmark: pgfId-7283421]software patches and updates
 
     
 
     [bookmark: pgfId-7283425]You can use the Defense Center to install an update on the devices it manages.
 
    
 
     
      [bookmark: pgfId-7283431][bookmark: 65372]Using Redund[bookmark: marker-7283427]ant Defense Centers
 
     [bookmark: pgfId-7856850]License: Any
 
     [bookmark: pgfId-7856859]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7622127]You can set up two Defense Centers as a high availability pair. This ensures redundant functionality in case one of the Defense Centers fails. Policies, user accounts, and more are shared between the two Defense Centers. Events are automatically sent to both Defense Centers. See Configuring High Availability for more information.[bookmark: 11970]
 
    
 
   
 
    
     [bookmark: pgfId-7963602][bookmark: 31403]Understanding [bookmark: marker-7963601]Management Interfaces
 
    [bookmark: pgfId-7963606]Management interfaces provide the means of communication between the Defense Center and all devices it manages. Maintaining good traffic control between the appliances is essential to the success of your deployment.
 
    [bookmark: pgfId-8062580]On Series 3 appliances and virtual Defense Centers, you can change the default configuration to enable the management interface on the Defense Center, device, or both, to sort traffic between the appliances into two separate traffic channels. The management traffic channel carries all internal traffic (such as inter-device traffic specific to the management of the appliance and the system), and the event traffic channel carries all event traffic (such as web events). When you split traffic into two channels, you create two connection points between the appliances, increasing throughput and thus improving performance. You can also enable multiple management interfaces, each with a unique IP address (IPv4 or IPv6) and hostname, to separate and manage traffic channels and provide still greater throughput. 
 
    [bookmark: pgfId-8062686]With multiple management interfaces, you can also isolate and manage traffic from different networks using only one Defense Center. You use a management interface to add a static route to the destination network, and register devices to the separate management interfaces to ensure that traffic from one network is isolated from traffic on another network. You can send both traffic channels on the same interface, or, if you have enough additional management interfaces, you can both isolate the network traffic and configure each management interface to carry only one traffic channel. 
 
    [bookmark: pgfId-7963621]Management interfaces are often located on the back of the appliance. See Identifying the Management Interfaces in FireSIGHT System Installation Guide for more information. To learn more about management interfaces, see the following sections for more information:
 
     
     	 [bookmark: pgfId-7963628]Using a Single Management Interface
 
     	 [bookmark: pgfId-7963632]Using Multiple Management Interfaces
 
     	 [bookmark: pgfId-7963636]Using Traffic Channels
 
     	 [bookmark: pgfId-7963640]Using Network Routes
 
    
 
     
      [bookmark: pgfId-7963642][bookmark: 40725]Using a Single Management Interface
 
     [bookmark: pgfId-7963646]License: Any
 
     [bookmark: pgfId-7963650]Supported Devices: Any
 
     [bookmark: pgfId-7963654]Supported Defense Centers: Any
 
     [bookmark: pgfId-7963658]When you register your device to a Defense Center, you establish a single communication channel that carries all traffic between the management interface on the Defense Center and the management interface on the device. 
 
     [bookmark: pgfId-7963662]The following graphic shows the default single communication channel. One interface carries one communication channel that contains both management and event traffic.
 
     [bookmark: pgfId-8232579]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-7963672][bookmark: 34073]Using Multiple Management Interfaces
 
     [bookmark: pgfId-7963676]License: Any
 
     [bookmark: pgfId-7963683]Supported Devices: Series 3
 
     [bookmark: pgfId-7963690]Supported Defense Centers: Series 3, Virtual
 
     [bookmark: pgfId-7963691]You can enable and configure multiple management interfaces, each with a unique IP address (IPv4 or IPv6) and, optionally, a hostname, to provide greater traffic throughput by sending each traffic channel to a different management interface. Configure a smaller interface to carry the lighter management traffic load, and a larger interface to carry the heavier event traffic load. You can register devices to separate management interfaces and configure both traffic channels for the same interface, or use a dedicated management interface to carry the event traffic channels for all devices managed by the Defense Center. 
 
     [bookmark: pgfId-8071221]You can also create a route from a specific management interface on your Defense Center to a device on a different network. When you register a device on a different network to a non-default management interface, traffic on that device is isolated from traffic on devices registered to the default (eth0) management interface. See Using Network Routes for more information.
 
     [bookmark: pgfId-8071228]Non-default management interfaces have many of the same capabilities as the default management interface (such as using high availability between the Defense Centers) with the following exceptions:
 
      
      	 [bookmark: pgfId-7963706]You can configure DHCP on the default ( eth0 ) management interface only. Additional ( eth1 and so on) interfaces require unique static IP addresses and hostnames.
 
      	 [bookmark: pgfId-7963707]You must configure both traffic channels to use the same management interface when you use a non-default management interface to connect your Defense Center and managed device and those appliances are separated by a NAT device.
 
      	 [bookmark: pgfId-7963711]You can use Lights-Out Management on the default management interface only.
 
      	 [bookmark: pgfId-7963715]On the 70xx Family, you can separate traffic into two channels and configure those channels to send traffic to one or more management interfaces on the Defense Center. However, because the 70xx Family contains only one management interface, the device receives traffic sent from the Defense Center on only one management interface.
 
     
 
    
 
     
      [bookmark: pgfId-7963727][bookmark: 94256]Using Tr[bookmark: marker-7963726]affic Channels
 
     [bookmark: pgfId-7963731]License: Any
 
     [bookmark: pgfId-7963738]Supported Devices: Series 3
 
     [bookmark: pgfId-7963745]Supported Defense Centers: Series 3, Virtual
 
     [bookmark: pgfId-7963746]When you use two traffic channels on one management interface, you create two connections between the Defense Center and the managed device. One channel carries management traffic and one carries event traffic, separately and on the same interface.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7963759]When you use multiple management interfaces, you can improve your performance by dividing the traffic channels over two management interfaces, thus increasing the traffic flow by adding the capacity of both interfaces. One interface carries the management traffic channel and the other carries the event traffic channel. If either interface fails, all traffic reroutes to the active interface and the connection is maintained. 
 
     [bookmark: pgfId-7963760]The following graphic shows the management traffic channel and the event traffic channel over two management interfaces. 
 
     [bookmark: pgfId-8232624]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7963769]You can use a dedicated management interface to carry only event traffic from multiple devices. In this configuration, each device is registered to a different management interface to carry the management traffic channel, and one management interface on the Defense Center carries all event traffic channels from all devices. If an interface fails, traffic reroutes to the active interface and the connection is maintained. Note that because event traffic for all devices is carried on the same interface, traffic is not isolated between networks. 
 
     [bookmark: pgfId-7963773]The following graphic shows two devices using different management channel traffic interfaces sharing the same dedicated interface for event traffic channels. 
 
     [bookmark: pgfId-8232648]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7963782]When you use two traffic channels on one management interface, you create two connections between the Defense Center and the managed device. One channel carries management traffic and one carries event traffic, separately and on the same interface. Using multiple management interfaces, you can improve your performance further by dividing the traffic channels over two management interfaces, thus increasing the traffic flow by adding the capacity of both interfaces. One interface carries the management traffic channel and the other carries the event traffic channel. If either interface fails, all traffic reroutes to the active interface and the connection is maintained.
 
     [bookmark: pgfId-7963786]You can also use a dedicated management interface to carry only event traffic from multiple devices. In this configuration, each device is registered to a different management interface to carry the management traffic channel, and one management interface on the Defense Center carries all event traffic channels from all devices. If an interface fails, traffic reroutes to the active interface and the connection is maintained. Note that because event traffic for all devices is carried on the same interface, traffic is not isolated between networks.
 
    
 
     
      [bookmark: pgfId-7963792][bookmark: 94798]Using Net[bookmark: marker-7963791]work Routes
 
     [bookmark: pgfId-7963796]License: Any
 
     [bookmark: pgfId-7963803]Supported Devices: Series 3
 
     [bookmark: pgfId-7963810]Supported Defense Centers: Series 3, Virtual
 
     [bookmark: pgfId-7963814]You can create a route from a specific management interface on your Defense Center to a different network. When you register a device from that network to the specified management interface on the Defense Center, you provide an isolated connection between the Defense Center and the device on a different network. Configure both traffic channels to use the same management interface to ensure that traffic from that device remains isolated from device traffic on other networks. Because the routed interface is isolated from all other interfaces on the Defense Center, if the routed management interface fails, the connection is lost.
 
      
       
     
 
     
 
     [bookmark: pgfId-8071253]Tip Cisco recommends that you use the static IP address when you register a Defense Center and its devices using any management interface other than the default (eth0) management interface. DHCP is supported only on the default management interface.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8071257]After you install your Defense Center, you configure multiple management interfaces using the web interface. See Configuring Appliance Settings in the FireSIGHT System User Guide for more information.
 
     [bookmark: pgfId-7963832]The following graphic shows two devices isolating network traffic by using separate management interfaces for all traffic. You can add more management interfaces to configure separate management and event traffic channel interfaces for each device. 
 
     [bookmark: pgfId-8232672]
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     [bookmark: pgfId-7916788][bookmark: 75198]Working in NA[bookmark: marker-7916786]T Environme[bookmark: marker-7916787]nts
 
    [bookmark: pgfId-7916795]License: Any
 
    [bookmark: pgfId-7279460]Network address translation (NAT) is a method of transmitting and receiving network traffic through a router that involves reassigning the source or destination IP address as the traffic passes through the router. Typical applications using NAT enable multiple hosts on a private network to use a single public IP address to access the public network.
 
    [bookmark: pgfId-7279469]When you add a device to a Defense Center, you establish communications between the appliances. The information you need to establish communications depends on whether the environment uses NAT:
 
     
     	 [bookmark: pgfId-7279471]In an environment without NAT, you need a registration key and the IP addresses or fully qualified domain names of both appliances.
 
     	 [bookmark: pgfId-7279472]In an environment with NAT, you need a registration key and a unique NAT ID.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7279473]Note The NAT ID must be unique among all NAT IDs used to register devices to a Defense Center.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7963848]Note that when you use a non-default management interface to connect your Defense Center and managed device and those appliances are separated by a NAT device, you must configure both traffic channels to use the same management interface.
 
    [bookmark: pgfId-7925836]The following diagram shows a Defense Center managing two devices in a NAT environment. You can use the same registration key when adding both devices, because registration keys do not have to be unique. However, you must use unique NAT IDs when adding the devices to the Defense Center.
 
     
      [bookmark: pgfId-8232696]
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     [bookmark: pgfId-7819313][bookmark: 90020][bookmark: 75974][bookmark: 67572]Con[bookmark: marker-7819311]figuring High Availability
 
    [bookmark: pgfId-7819314]License: Any
 
    [bookmark: pgfId-7819327]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
    [bookmark: pgfId-7279756]To ensure the continuity of operations, the high availability feature allows you to designate redundant Defense Centers to manage devices. Event data streams from managed devices to both Defense Centers and certain configuration elements are maintained on both Defense Centers. If one Defense Center fails, you can monitor your network without interruption using the other Defense Center.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7540908] 
     Caution Because the system restricts some functionality to the primary Defense Center, if that appliance fails, you must promote the secondary Defense Center to Active. See 
     Monitoring and Changing High Availability Status. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7279772]See the following sections for more information about setting up high availability:
 
     
     	 [bookmark: pgfId-7279776]Using High Availability lists the configurations that are and are not shared when you implement high availability.
 
     	 [bookmark: pgfId-7279780]Guidelines for Implementing High Availability outlines guidelines you must follow if you want to implement high availability.
 
     	 [bookmark: pgfId-7279784]Setting Up High Availability explains how to specify primary and secondary Defense Centers.
 
     	 [bookmark: pgfId-7279791]Monitoring and Changing High Availability Status explains how to check the status of your linked Defense Centers and how to change the roles of the Defense Center if the primary Defense Center fails.
 
     	 [bookmark: pgfId-7279798]Disabling High Availability and Unregistering Devices explains how to permanently remove the link between linked Defense Centers.
 
     	 [bookmark: pgfId-7279805]Pausing Communication Between Paired Defense Centers explains how to pause communications between linked Defense Centers.
 
     	 [bookmark: pgfId-7279812]Restarting Communication Between Paired Defense Centers explains how to restart communications between linked Defense Centers.
 
    
 
     
      [bookmark: pgfId-7279817][bookmark: 64647]Using High Avail[bookmark: marker-7368396]ability
 
     [bookmark: pgfId-7279818]License: Any
 
     [bookmark: pgfId-8058166]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-8058352]DC1500s, DC2000s, DC3500s, and DC4000s support high availability configurations; DC750s and the virtual Defense Centers do not. Cisco strongly recommends that both Defense Centers in a high availability pair be the same model. Do not attempt to set up high availability between different Defense Center models.
 
     [bookmark: pgfId-8012188][bookmark: marker-8012184]Although Defense Centers in high availability mode are designated primary and secondary, you can make policy or other changes to either Defense Center. However, Cisco recommends that you change configurations only on the primary Defense Center and that you keep your secondary Defense Center as a backup.
 
     [bookmark: pgfId-8012204]Defense Centers periodically update each other on changes to their configurations, and any change you make to one Defense Center should be applied on the other Defense Center within ten minutes. (Each Defense Center has a five-minute synchronization cycle, but the cycles themselves could be out of synchronization by as much as five minutes, so changes appear within two five-minute cycles.) During this ten-minute window, configurations may appear differently on the Defense Centers.
 
     [bookmark: pgfId-7279872]For example, if you create a policy on your primary Defense Center and apply it to a device that is also managed by your secondary Defense Center, the device could contact the secondary Defense Center before the Defense Centers contact each other. Because the device has a policy applied to it that the secondary Defense Center does not recognize, the secondary Defense Center displays a new policy with the name “unknown” until the Defense Centers synchronize.
 
     [bookmark: pgfId-7279894]Also, if you make conflicting policy or other changes to both Defense Centers within the same window between Defense Centers syncs, the last change you make takes precedence, regardless of the designations of the Defense Center as primary and secondary.
 
     [bookmark: pgfId-7279901]Before you establish a high availability pair, note the following prerequisites:
 
      
      	 [bookmark: pgfId-7279905]Make sure both Defense Centers have a user account named  admin with Administrator privileges. These accounts must use the same password.
 
      	 [bookmark: pgfId-7279909]Make sure that other than the  admin account, the two Defense Centers do not have user accounts with identical user names. Remove or rename one of the duplicate user accounts before you establish high availability.
 
     
 
     [bookmark: pgfId-7279923]Note that Defense Centers configured as a high availability pair do not need to be on the same trusted management network, nor do they have to be in the same geographic location.
 
     [bookmark: pgfId-8108601]To ensure continuity of operations, both Defense Centers in a high availability pair must have Internet access; see Internet Access Requirements. For specific features, the primary Defense Center contacts the Internet, then shares information with the secondary during the synchronization process. Therefore, if the primary fails, you should promote the secondary to Active as described in Monitoring and Changing High Availability Status.
 
     [bookmark: pgfId-8108611]For more information on which configurations are shared or not shared between members of a high availability pair, see:
 
      
      	 [bookmark: pgfId-7279929]Shared Configurations
 
      	 [bookmark: pgfId-7279933]Health and System Policies
 
      	 [bookmark: pgfId-7279937]Correlation Responses
 
      	 [bookmark: pgfId-7279941]Licenses
 
      	 [bookmark: pgfId-7279945]URL Filtering and Security Intelligence
 
      	 [bookmark: pgfId-8058105]Cloud Connections and Malware Information
 
      	 [bookmark: pgfId-8058109]User Agents
 
     
 
    
 
     
      [bookmark: pgfId-8058112][bookmark: 12588]Shared Configur[bookmark: marker-8058111]ations
 
     [bookmark: pgfId-8012561]License: Any
 
     [bookmark: pgfId-8012577]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-8012582]Defense Centers in a high availability pair [bookmark: marker-8012581]share the following information:
 
      
      	 [bookmark: pgfId-7279959]user account attributes, authentication configurations, and custom user roles
 
      	 [bookmark: pgfId-7507062]authentication objects for user accounts and user awareness, as well as the users and groups that are available to user conditions in access control rules
 
      	 [bookmark: pgfId-7279960]custom dashboards
 
      	 [bookmark: pgfId-7279966]custom workflows and tables
 
      	 [bookmark: pgfId-7279969]device attributes, such as the device’s host name, where events generated by the device are stored, and the group in which the device resides
 
      	 [bookmark: pgfId-7279970]access control, SSL, network analysis, intrusion, file, and network discovery policies
 
      	 [bookmark: pgfId-7279972]local intrusion rules
 
      	 [bookmark: pgfId-8014053]custom intrusion rule classifications
 
      	 [bookmark: pgfId-7279974]network discovery policies
 
      	 [bookmark: pgfId-7279975]user-defined application protocol detectors and the applications they detect
 
      	 [bookmark: pgfId-7279976]activated custom fingerprints
 
      	 [bookmark: pgfId-7279977]host attributes 
 
      	 [bookmark: pgfId-7279979]network discovery user feedback, including notes and host criticality; the deletion of hosts, applications, and networks from the network map; and the deactivation or modification of vulnerabilities
 
      	 [bookmark: pgfId-7279980]correlation policies and rules, compliance white lists, and traffic profiles
 
      	 [bookmark: pgfId-7279982]change reconciliation snapshots and report settings
 
      	 [bookmark: pgfId-7555977]intrusion rule, geolocation database (GeoDB), and vulnerability database (VDB) updates
 
      	 [bookmark: pgfId-8073663]reusable objects, including variable sets, associated with any of the above configurations
 
     
 
    
 
     
      [bookmark: pgfId-7279987][bookmark: 64588]Health and System P[bookmark: marker-7279986]olicies
 
     [bookmark: pgfId-7279988]License: Any
 
     [bookmark: pgfId-7622277]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7279992]Health and system policies for Defense Centers and managed devices are shared in high availability pairs. Allow enough time to ensure that information about health policies, modules, blacklists, is synchronized on a newly activated Defense Center.
 
      
       
     
 
     
 
     [bookmark: pgfId-7280012]Note Although system policies are shared by Defense Centers in a high availability pair, they are not automatically applied. If you want identical system policies on both Defense Centers, apply the policy after it synchronizes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7280020]Defense Centers in a high availability [bookmark: marker-7280019]pair share the following system and health policy information:
 
      
      	 [bookmark: pgfId-7280021]system policies
 
      	 [bookmark: pgfId-7280022]system policy configurations (what policy is applied where)
 
      	 [bookmark: pgfId-7280023]health policies
 
      	 [bookmark: pgfId-7280024]health monitoring configurations (what policy is applied where)
 
      	 [bookmark: pgfId-7280025]which appliances are blacklisted from health monitoring
 
      	 [bookmark: pgfId-7280026]which appliances have individual health monitoring policies blacklisted
 
     
 
    
 
     
      [bookmark: pgfId-7280028][bookmark: 77144]Correlation Resp[bookmark: marker-7368401]onses
 
     [bookmark: pgfId-7280029]License: Any
 
     [bookmark: pgfId-7622290]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7280033]Although Defense Centers share correlation policies, rules, and responses, Defense Centers do not share the associations between correlation rules and their responses. This is to avoid launching duplicate responses when correlation policies are violated.
 
     [bookmark: pgfId-7280037]You must upload and install any custom remediation modules and configure remediation instances on your secondary Defense Center before remediations are available to associate with correlation policies. If the primary Defense Center fails, not only should you quickly associate your correlation policies with the appropriate responses and remediations on the secondary Defense Center, but you must also use the web interface on the secondary Defense Center to promote it to Active to maintain continuity of operations. For more information, see Monitoring and Changing High Availability Status. For more information about correlation responses, see Creating Correlation Policies and Creating Remediations.
 
     [bookmark: pgfId-7280056]When you restore your primary Defense Center after a failure, if you created associations between rules or white lists and their responses and remediations on the secondary Defense Center, make sure you remove the associations so responses and remediations will only be generated by the primary Defense Center.
 
    
 
     
      [bookmark: pgfId-7280064][bookmark: 25161]Licens[bookmark: marker-7600465]es
 
     [bookmark: pgfId-7280065]License: Any
 
     [bookmark: pgfId-7622303]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7579436]Defense Centers in a high availability pair do not share licenses. You must add equivalent licenses to each member of the pair. For more information, see Understanding Licensing.
 
    
 
     
      [bookmark: pgfId-7579443][bookmark: 85437]URL Filte[bookmark: marker-7579441]ring and Security Intelligen[bookmark: marker-7579442]ce
 
     [bookmark: pgfId-7579444]License: URL Filtering or Protection
 
     [bookmark: pgfId-7621843]Supported Devices: Series 3, virtual, X-Series, ASA FirePOWER
 
     [bookmark: pgfId-7622316]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7508179]URL filtering and Security Intelligence configurations and information are synchronized between Defense Centers in a high availability deployment. However, only the primary Defense Center downloads URL category and reputation data and for updates to Security Intelligence feeds.
 
     [bookmark: pgfId-7839859]If the primary Defense Center fails, not only must you make sure that the secondary Defense Center can access the URL filtering cloud and any configured feed sites, but you must also use the web interface on the secondary Defense Center to promote it to Active. For information, see Monitoring and Changing High Availability Status.
 
    
 
     
      [bookmark: pgfId-7839874][bookmark: 31557]Cloud Connecti[bookmark: marker-7839873]ons and Malware Information
 
     [bookmark: pgfId-7839878]License: Any or Malware
 
     [bookmark: pgfId-7732266]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-7732267]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7506326]Although they share file policies and related configurations, Defense Centers in a high availability pair share neither Collective Security Intelligence Cloud connections nor malware dispositions. To ensure continuity of operations, and to ensure that detected files’ malware dispositions are the same on both Defense Centers, both primary and secondary Defense Centers must have access to the cloud. For more information, see Understanding Malware Protection and File Control.
 
    
 
     
      [bookmark: pgfId-7506036][bookmark: 66551]User A[bookmark: marker-7506035]gents
 
     [bookmark: pgfId-7506043]License: FireSIGHT
 
     [bookmark: pgfId-7622340]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7280096]User Agents can connect to up to five Defense Centers at a time. You should connect agents to the primary Defense Center. If the primary Defense Center fails, you must make sure that any agents can communicate with the secondary Defense Center. See Using User Agents to Report Active Directory Logins for more information.
 
    
 
     
      [bookmark: pgfId-7280108][bookmark: 86410]Guidelines for Imple[bookmark: marker-7280107]menting High Availability
 
     [bookmark: pgfId-7280109]License: Any
 
     [bookmark: pgfId-7622352]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7280110]To take advantage of high availability, you must follow the guidelines in the following sections.
 
     [bookmark: pgfId-7580587]Primary and Secondary Defense Center Requirements
 
     [bookmark: pgfId-7280117]You must designate one Defense Center as the primary Defense Center and one as the secondary. When appliances switch from Active to Inactive (and vice versa), they retain their original primary and secondary designations.
 
     [bookmark: pgfId-7280120]Regardless of their designations as primary and secondary, both Defense Centers can be configured with policies, rules, managed devices, and so on before you set up high availability.
 
     [bookmark: pgfId-7342294]To avoid confusion, start with the secondary Defense Center in its original state. That is, you have not created or modified any policies, nor created any new rules, nor have you previously managed any devices with it. To make sure the secondary Defense Center is in its original state, restore it to factory defaults. Note that this also deletes event and configuration data from the Defense Center. For more information, see the FireSIGHT System Installation Guide.
 
     [bookmark: pgfId-7580733]Version Requirements
 
     [bookmark: pgfId-7280149]Both Defense Centers must be running the same software and rule update version. Additionally, this software version must be the same or newer than the software version of managed devices.
 
     [bookmark: pgfId-7580782]Communication Requirements
 
     [bookmark: pgfId-7580766]B[bookmark: marker-7580762]y default, paired Defense Centers use port 8305/tcp for communications. You can change the port as described in Changing the Management Port.
 
     [bookmark: pgfId-7925897]The two Defense Centers do not need to be on the same network segment, but each of the Defense Centers must be able to communicate with the other and with the devices they share. That is, the primary Defense Center must be able to contact the secondary Defense Center at the IP address on the secondary Defense Center’s own management interface, and vice versa. In addition, each Defense Center must be able to contact the devices it manages or the devices must be able to contact the Defense Center.
 
    
 
     
      [bookmark: pgfId-7925918][bookmark: 84807]Setting Up High Avail[bookmark: marker-7925916]ability
 
     [bookmark: pgfId-7280207]License: Any
 
     [bookmark: pgfId-7622364]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7614292]To use high availability, you must designate one Defense Center as the primary and another Defense Center of the same model as the secondary. For information about editing the remote management communications between the two appliances, see Editing Remote Management.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7280221] 
      Caution Cisco recommends that you change configurations 
      only on the primary Defense Center and that you use your secondary Defense Center as a backup. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7280228]Before you configure high availability, make sure you synchronize time settings between the Defense Centers you want to link. For details on setting time, see Synchronizing Time.
 
     [bookmark: pgfId-7498896]Depending upon the number of policies and custom standard text rules they have, it may take up to 10 minutes before all the rules and policies appear on both Defense Centers. You can view the High Availability page to check the status of the link between the two Defense Centers. You can also monitor the Task Status to see when the process completes. See Monitoring and Changing High Availability Status.
 
     [bookmark: pgfId-7498949]If one of the Defense Centers in the high availability pair must be reimaged, disable the high availability link first. After you reimage the Defense Center, re-establish the high availability pair and the data will synchronize from the existing Defense Center to the newly added Defense Center. If a Defense Center cannot be reimaged (for example, the appliance has failed), contact Support.
 
     [bookmark: pgfId-7280238]To set up high availability for two Defense Centers:
 
     [bookmark: pgfId-7280239]Access: Admin
 
     
 
     [bookmark: pgfId-7280243]Step 1 Log into the Defense Center that you want to designate as the secondary Defense Center.
 
     [bookmark: pgfId-7280247]Step 2 Select System > Local > Registration.
 
     [bookmark: pgfId-7280248]The Registration page appears.
 
     [bookmark: pgfId-7307932]Step 3 Click High Availability.
 
     [bookmark: pgfId-7307963]The High Availability page appears.
 
     [bookmark: pgfId-7280252]Step 4 Click the secondary Defense Center option.
 
     [bookmark: pgfId-7280256]The Secondary Defense Center Setup page appears.
 
     [bookmark: pgfId-7280264]Step 5 Type the hostname or IP address of the primary Defense Center in the Primary DC Host text box.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7280268] 
      Caution Make sure you use hostnames rather than IP addresses if your network uses DHCP to assign IP addresses. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7280272]Note that you can leave the Primary DC Host field empty if the management host does not have a routable address. In that case, use both the Registration Key and the Unique NAT ID fields.
 
     [bookmark: pgfId-7280275]Step 6 [bookmark: 14266]Type a one-time-use registration key in the Registration Key [bookmark: marker-7280274]text box 
 
     [bookmark: pgfId-7280278]Step 7 [bookmark: 33540]Optionally, in the Unique NAT ID [bookmark: marker-7280277]field, type a unique alphanumeric registration ID that you want to use to identify the primary Defense Center. Do not see Managing Stacked Devices. See Working in NAT Environments on 4-8 for more information.
 
     [bookmark: pgfId-7280285]Step 8 Click Register.
 
     [bookmark: pgfId-7280287]A success message appears, and the P[bookmark: marker-7280286]eer Manager page appears, showing the current state of the secondary Defense Center.
 
     [bookmark: pgfId-7280294]Step 9 Using an account with Admin access, log into the Defense Center that you want to designate as the primary.
 
     [bookmark: pgfId-7308075]Step 10 Select System > Local > Registration.
 
     [bookmark: pgfId-7308076]The Registration page appears.
 
     [bookmark: pgfId-7308077]Step 11 Click High Availability.
 
     [bookmark: pgfId-7308078]The High Availability page appears.
 
     [bookmark: pgfId-7280300]Step 12 Click the primary Defense Center option.
 
     [bookmark: pgfId-7280304]The Primary Defense Center Setup page appears.
 
     [bookmark: pgfId-7280312]Step 13 Type the hostname or IP address of the secondary Defense Center in the Secondary DC Host text box.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7280316] 
      Caution Make sure you use hostnames rather than IP addresses if your network uses DHCP to assign IP addresses. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7280317]Step 14 Type the same one-time-use registration key in the Registration Key text box you used in step 6.
 
     [bookmark: pgfId-7280324]Step 15 If you used a unique NAT ID on the secondary Defense Center, type the same registration ID that you used in step 7 in the Unique NAT ID text box.
 
     [bookmark: pgfId-7280328]Step 16 Click Register.
 
     [bookmark: pgfId-7547762]A success message appears, and the Peer Manager page appears, showing the current state of the primary Defense Center.
 
     [bookmark: pgfId-7876198]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7540745][bookmark: 82917]Monito[bookmark: marker-7540742]ring and Changing High Availa[bookmark: marker-7540744]bility Status
 
     [bookmark: pgfId-7280392]License: Any
 
     [bookmark: pgfId-8052681]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-8052696]After you have identified your primary and secondary Defense Centers, from either appliance in the high availability pair you can view information about the local Defense Center and its peer, including:
 
      
      	 [bookmark: pgfId-8045550]the peer IP address or host name
 
      	 [bookmark: pgfId-8045551]the peer product model
 
      	 [bookmark: pgfId-8045552]the peer software version
 
      	 [bookmark: pgfId-8045553]the peer operating system
 
      	 [bookmark: pgfId-8045554]the amount of time since the members of the high availability pair last synchronized
 
      	 [bookmark: pgfId-8045555]the role and status of the local appliance (Active & Primary, Inactive & Primary, Inactive & Secondary, or Active & Secondary)
 
     
 
     [bookmark: pgfId-8020515]You can also use the High Availability page to change the roles of the Defense Centers if the primary Defense Center fails. Because the system restricts the following functionality to the primary Defense Center, if that appliance fails, you must promote the secondary Defense Center to Active:
 
      
      	 [bookmark: pgfId-7556719]Updates to URL category and reputation data; see URL Filtering and Security Intelligence for more information.
 
      	 [bookmark: pgfId-7556760]Updates to Security Intelligence feeds; see URL Filtering and Security Intelligence for more information.
 
      	 [bookmark: pgfId-7556819]Associations between correlation rules and responses; see Correlation Responses for more information.
 
     
 
     [bookmark: pgfId-7556573]To check high availability status:
 
     [bookmark: pgfId-7280406]Access: Admin
 
     
 
     [bookmark: pgfId-8030073]Step 1 Log into one of the Defense Centers that you linked using high availability.
 
     [bookmark: pgfId-8030074]Step 2 Select System > Local > Registration.
 
     [bookmark: pgfId-8030075]The Registration page appears.
 
     [bookmark: pgfId-8030076]Step 3 Click High Availability.
 
     [bookmark: pgfId-8031258]The High Availability page appears.
 
     [bookmark: pgfId-8045564]Step 4 Under High Availability Status, you can view the following information about the Defense Centers in the high availability pair:
 
      
      	 [bookmark: pgfId-8045565]the peer IP address or host name
 
      	 [bookmark: pgfId-8045566]the peer product model
 
      	 [bookmark: pgfId-8045567]the peer software version
 
      	 [bookmark: pgfId-8045568]the peer operating system
 
      	 [bookmark: pgfId-8045569]the amount of time since the members of the high availability pair last synchronized
 
      	 [bookmark: pgfId-8045570]the role and status of the local appliance (Active & Primary, Inactive & Primary, Inactive & Secondary, or Active & Secondary)
 
      	 [bookmark: pgfId-8039507]the option to switch roles between the two Defense Centers
 
     
 
     [bookmark: pgfId-8030116]Step 5 The two Defense Centers automatically synchronize within ten minutes (five minutes for each Defense Center) after any action that affects a shared feature. For example, if you create a new policy on one Defense Center, it is automatically shared with the other Defense Center within 5 minutes. However, if you want to synchronize the policy immediately, click Synchronize.
 
      
       
     
 
     
 
     [bookmark: pgfId-8030127]Note If you delete a device from a Defense Center configured in a high availability pair and intend to re-add it, Cisco recommends that you wait at least five minutes before adding the device back. This interval ensures that the high availability pair resynchronizes first. If you do not wait five minutes, it may take more than one synchronization cycle to add the device to both Defense Centers.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8030134]Step 6 Click Switch Roles to change the local role from Active to Inactive, or Inactive to Active. 
 
     [bookmark: pgfId-8030135]With the Primary or Secondary designation unchanged, the roles are switched between the two peers.
 
     [bookmark: pgfId-8030136]Step 7 Click Peer Manager in the toolbar.
 
     [bookmark: pgfId-8030137]The Peer Manager page appears.
 
     [bookmark: pgfId-8030138]You can view the following information:
 
      
       
       	 [bookmark: pgfId-8030142]the IP address of the other Defense Center in the high availability pair
 
       	 [bookmark: pgfId-8030143]the status, registered or unregistered, of the communications link
 
       	 [bookmark: pgfId-8030144]the state, enabled or disabled, of the high availability pair
 
      
 
     
 
     [bookmark: pgfId-8030145]For information about editing the remote management communications between the two appliances, see Editing Remote Management.
 
     [bookmark: pgfId-7876205]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7280481][bookmark: 50722]Disabling High Availabil[bookmark: marker-7368441]ity and Unregistering Devices
 
     [bookmark: pgfId-7280482]License: Any
 
     [bookmark: pgfId-7622412]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7280486]If you want to remove one of the Defense Centers from a high availability pair, you must first disable the high availability link between them.
 
     [bookmark: pgfId-7280487]To disable a high availability pair:
 
     [bookmark: pgfId-7280488]Access: Admin
 
     
 
     [bookmark: pgfId-7280492]Step 1 Log into one of the Defense Centers in the high availability pair.
 
     [bookmark: pgfId-7309060]Step 2 Select System > Local > Registration.
 
     [bookmark: pgfId-7309061]The Registration page appears.
 
     [bookmark: pgfId-7309062]Step 3 Click High Availability.
 
     [bookmark: pgfId-7280493]The High Availability page appears.
 
     [bookmark: pgfId-7280495]Step 4 Select one of the following options from the Handle Registered Devices drop-down list:
 
      
       
       	 [bookmark: pgfId-7280499]To control all the managed devices with the Defense Center where you are accessing this page, select  Unregister devices on the other peer .
 
       	 [bookmark: pgfId-7280503]To control all the managed devices with the other Defense Center, select  Unregister devices on this peer .
 
       	 [bookmark: pgfId-7280504]To stop managing the devices altogether, select  Unregister devices on both peers .
 
      
 
     
 
     [bookmark: pgfId-7280505]Step 5 Click Break High Availability.
 
     [bookmark: pgfId-7280506]After you answer the prompt Do you really want to Break High Availability? by selecting OK, high availability is disabled and any managed devices are deleted from the Defense Centers according to your selection.
 
     [bookmark: pgfId-7417324]You can enable high availability with a different Defense Center as described in Setting Up High Availability.
 
     [bookmark: pgfId-7876233]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7417333][bookmark: 60251]Pausing Communication [bookmark: marker-7417329]Between Paired Defense Centers
 
     [bookmark: pgfId-7417334]License: Any
 
     [bookmark: pgfId-7622429]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7417311]If you want to temporarily disable high availability, you can disable the communications channel between the Defense Centers.
 
     [bookmark: pgfId-7280528]To disable the communications channel for a high availability pair:
 
     [bookmark: pgfId-7280529]Access: Admin
 
     
 
     [bookmark: pgfId-7280530]Step 1 Click Peer Manager.
 
     [bookmark: pgfId-7280531]The Peer Manager page appears.
 
     [bookmark: pgfId-7280536]Step 2 Click the slider to disable the communications channel between the two Defense Centers.
 
     [bookmark: pgfId-7280540]For information about editing the remote management communications between the two appliances, see Editing Remote Management.
 
     [bookmark: pgfId-7876262]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7417293][bookmark: 71469]Restarting Communication [bookmark: marker-7417289]Between Paired Defense Centers
 
     [bookmark: pgfId-7417294]License: Any
 
     [bookmark: pgfId-7622443]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-7417295]If you temporarily disabled high availability, you can enable the communications channel between the Defense Centers to restart high availability.
 
     [bookmark: pgfId-7280555]To enable the communications channel for a high availability pair:
 
     [bookmark: pgfId-7280556]Access: Admin
 
     
 
     [bookmark: pgfId-7280557]Step 1 Click Peer Manager.
 
     [bookmark: pgfId-7280558]The Peer Manager page appears.
 
     [bookmark: pgfId-7280563]Step 2 Click the slider to enable the communications channel between the two Defense Centers.
 
     [bookmark: pgfId-7280567]For information about editing the remote management communications between the two appliances, see Editing Remote Management.
 
     [bookmark: pgfId-7876278]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7294875][bookmark: 97239]Working with De[bookmark: marker-7368448]vices
 
    [bookmark: pgfId-7570648]License: Any
 
    [bookmark: pgfId-7294879]You can use the Defense Center to manage the full range of devices that are a part of the FireSIGHT System. When you manage a device, you set up a two-way, SSL-encrypted communication channel between the Defense Center and the device. The Defense Center uses this channel to send information to the device about how you want to analyze and manage your network traffic.
 
    [bookmark: pgfId-7294889]As the device evaluates the traffic, it generates events and sends them to the Defense Center using the same channel.
 
    [bookmark: pgfId-7294896]See the following sections for more information about managing devices:
 
     
     	 [bookmark: pgfId-7294900]Understanding the Device Management Page
 
     	 [bookmark: pgfId-8122760]Configuring Remote Management
 
     	 [bookmark: pgfId-7294904]Adding Devices to the Defense Center
 
     	 [bookmark: pgfId-7311331]Configuring Remote Management
 
     	 [bookmark: pgfId-7294908]Managing Device Groups
 
     	 [bookmark: pgfId-7294912]Clustering Devices
 
     	 [bookmark: pgfId-7294916]Editing Device Configuration
 
     	 [bookmark: pgfId-7294920]Configuring Sensing Interfaces
 
    
 
     
      [bookmark: pgfId-7294862]Understanding [bookmark: marker-7205834]the [bookmark: Understanding the Device Management Page]Device Management Page
 
     [bookmark: pgfId-7207863]License: Any
 
     [bookmark: pgfId-7241016]The Device Management page provides you with a range of information and options that you can use to manage your registered devices, device clusters, and device groups. The page displays a list of all the devices currently registered on the Defense Center.
 
     [bookmark: pgfId-7244298]You can use the sort-by drop-down list to sort the appliance list according to your needs. Devices are displayed in the appliance list grouped by the category you select. You can sort by:
 
      
      	 [bookmark: pgfId-7244302]Group (that is, device group); see Managing Device Groups for more information
 
      	 [bookmark: pgfId-7244305]Type (that is, the type of licenses applied to the device); see Licensing the FireSIGHT System for more information
 
      	 [bookmark: pgfId-7244310]Model (that is, the model of the device being managed by the Defense Center)
 
      	 [bookmark: pgfId-7244314]Health Policy; see Using Health Monitoring for more information
 
      	 [bookmark: pgfId-7311961]System Policy; see Managing System Policies for more information
 
      	 [bookmark: pgfId-7311965]Access Control Policy; see Managing Access Control Policies for more information
 
     
 
     [bookmark: pgfId-7311966]For device groups, you can expand and collapse the list of devices in the group. The list appears collapsed by default.
 
      
       
        
        [bookmark: pgfId-7245521]Table 4-1 Appliance List Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-7245525]Field 
          
  
         	 
           
           [bookmark: pgfId-7245527]Description 
          
  
        
 
         
         	[bookmark: pgfId-7245529]Name
  
         	[bookmark: pgfId-7245531]A list of the hostname, IP address, device model, and software version for each device. The status icon to the left of the appliance indicates its current health status.
  
        
 
         
         	[bookmark: pgfId-7245536]License Type
  
         	[bookmark: pgfId-7245538]The licenses that are enabled on the managed device.
  
        
 
         
         	[bookmark: pgfId-7245543]Health Policy
  
         	[bookmark: pgfId-7245545]The currently applied health policy for the device. You can click the name of the health policy to view a read-only version of the policy. See Editing Health Policies for information about modifying an existing health policy.
  
        
 
         
         	[bookmark: pgfId-7245550]System Policy
  
         	[bookmark: pgfId-7245552]The currently applied system policy for the device. You can click the name of the system policy to view a read-only version of the policy. See Managing System Policies for more information.
  
        
 
         
         	[bookmark: pgfId-7245557]Access Control Policy
  
         	[bookmark: pgfId-7245559]A link to the currently applied access control policy. See Managing Access Control Policies.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7245565]See the following sections for more information:
 
      
      	 [bookmark: pgfId-7212322]Configuring Remote Management
 
      	 [bookmark: pgfId-8120356]Adding Devices to the Defense Center
 
      	 [bookmark: pgfId-7212366]Managing Device Groups
 
      	 [bookmark: pgfId-7260313]Clustering Devices
 
      	 [bookmark: pgfId-7794750]Managing Stacked Devices
 
     
 
    
 
     
      [bookmark: pgfId-8122202][bookmark: 18221]Configuring[bookmark: marker-8122199] Remote Management
 
     [bookmark: pgfId-8122208]License: Any
 
     [bookmark: pgfId-8122212]Before you can manage one FireSIGHT System appliance with another, you must set up a two-way, SSL-encrypted communication channel between the two appliances. The appliances use the channel to share configuration and event information. High availability peers also use the channel, which is by default on port 8305/tcp.
 
     [bookmark: pgfId-8122213]You must configure remote management on the appliance that will be managed, that is, on the device that you want to manage with a Defense Center. After you configure remote management, you can use the managing appliance’s web interface to add the managed appliance to your deployment.
 
     [bookmark: pgfId-8122220]Note that the procedure in this section explains how to configure remote management on FirePOWER physical appliances. 
 
     [bookmark: pgfId-8122221]To enable communications between two appliances, you must provide a way for the appliances to recognize each other. There are three criteria the FireSIGHT System uses when allowing communications:
 
      
      	 [bookmark: pgfId-8122225]the hostname or IP address of the appliance with which you are trying to establish communication
 
     
 
     [bookmark: pgfId-8122226]In NAT environments, even if the other appliance does not have a routable address, you must provide a hostname or an IP address either when you are configuring remote management, or when you are adding the managed appliance.
 
      
      	 [bookmark: pgfId-8122227]a self-generated alphanumeric registration key up to 37 characters in length that identifies the connection
 
      	 [bookmark: pgfId-8122231]an optional unique alphanumeric NAT ID that can help the FireSIGHT System establish communications in a NAT environment
 
     
 
     [bookmark: pgfId-8122232]The NAT ID must be unique among all NAT IDs used to register managed appliances. For more information, see Working in NAT Environments.
 
     [bookmark: pgfId-8122239]When you register a managed device to a Defense Center, you can select an access control policy to apply to the device. However, if the device is incompatible with the policy, the policy apply fails. This incompatibility could occur for multiple reasons, including licensing mismatches, model restrictions, passive vs inline issues, and other misconfigurations. If the initial access control policy apply fails, the initial network discovery policy apply also fails. After you resolve the issue that caused the failure, you must manually apply access control and network discovery policies to the device. For more information about issues that could cause access control policy apply to fail, see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-8122243]To configure remote management of the local appliance:
 
     [bookmark: pgfId-8122247]Access: Admin
 
     
 
     [bookmark: pgfId-8122248]Step 1 On the web interface for the device you want to manage, select System > Local > Registration.
 
     [bookmark: pgfId-8122249]The Remote Management page appears.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8122253] 
      Caution Cisco 
      strongly recommends that you not change the value for the management port. If you change it, you must also change it for all appliances in your deployment that need to communicate with each other. For more information, see 
      Changing the Management Port. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8122257]Step 2 Click Add Manager.
 
     [bookmark: pgfId-8122258]The Add Remote Management page appears.
 
     [bookmark: pgfId-8122259]Step 3 In the Management Host field, type the IP address or the hostname of the appliance that you want to use to manage this appliance.
 
     [bookmark: pgfId-8122260]The hostname is the fully qualified domain name or the name that resolves through the local DNS to a valid IP address.
 
     [bookmark: pgfId-8122261]In a NAT environment, you do not need to specify an IP address or hostname here if you plan to specify it when you add the managed appliance. In this case, the FireSIGHT System uses the NAT ID you will provide later to identify the remote manager on the managed appliance’s web interface.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8122265] 
      Caution Use a hostname rather than an IP address if your network uses DHCP to assign IP addresses. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8122266]Step 4 In the Registration Key field, type the registration key that you want to use to set up communications between appliances.
 
     [bookmark: pgfId-8122267]Step 5 For NAT environments, in the Unique NAT ID field, type a unique alphanumeric NAT ID that you want to use to set up communications between appliances.
 
     [bookmark: pgfId-8122268]Step 6 Click Save.
 
     [bookmark: pgfId-8122269]After the appliances confirm that they can communicate with each other, the Pending Registration status appears.
 
     [bookmark: pgfId-8122270]Step 7 Use the managing appliance’s web interface to add this appliance to your deployment.
 
     [bookmark: pgfId-8122274]For more information, see Adding Devices to the Defense Center.
 
      
       
     
 
     
 
     [bookmark: pgfId-8122275]Note When enabling remote management of a device, in some high availability deployments that use NAT, you may also need to add the secondary Defense Center as a manager. For more information, contact Support.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8122279]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8122283][bookmark: 91937]Editing Rem[bookmark: marker-8122281]ote Management
 
     [bookmark: pgfId-8122288]License: Any
 
     [bookmark: pgfId-8122289]Use the following procedure to edit the hostname or IP address of the managing appliance. You can also change the display name of the managing appliance, which is a name only used within the context of the FireSIGHT System. Although you can use the hostname as the display name of the appliance, entering a different display name does not change the hostname.
 
     [bookmark: pgfId-8122295]Note that you cannot add devices running software more than one major version lower than the Defense Center. For example, if your Defense Center is running Version 5.4.0, you can add devices running 5.3.x or higher but not devices running 5.2.x.
 
      
       
     
 
     
 
     [bookmark: pgfId-8124771]Tip You can click the slider to enable or disable management of the managed device. Disabling management blocks the connection between the Defense Center and the device, but does not delete the device from the Defense Center. If you no longer want to manage a device, see Deleting Devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8122304]To edit remote management:
 
     [bookmark: pgfId-8122308]Access: Admin
 
     
 
     [bookmark: pgfId-8122309]Step 1 On the web interface for the device, select System > Local > Registration.
 
     [bookmark: pgfId-8122310]The Remote Management page appears.
 ) next to the manager for which you want to edit remote management settings. 
     
 
     [bookmark: pgfId-8122315]The Edit Remote Management page appears.
 
     [bookmark: pgfId-8122316]Step 3 In the Name field, change the display name of the managing appliance.
 
     [bookmark: pgfId-8122317]Step 4 In the Host field, change the IP address or the hostname of the managing appliance.
 
     [bookmark: pgfId-8123498]The hostname is the fully qualified domain name or the name that resolves through the local DNS to a valid IP address. 
 
     [bookmark: pgfId-8123499]Step 5 Click Save.
 
     [bookmark: pgfId-8122320]Your changes are saved.
 
     [bookmark: pgfId-8122321]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8122324][bookmark: 51782]Changing the Manage[bookmark: marker-8122323]ment Port
 
     [bookmark: pgfId-8122328]License: Any
 
     [bookmark: pgfId-8122332]FireSIGHT System appliances communicate using a two-way, SSL-encrypted communication channel, which by default is on port 8305.
 
     [bookmark: pgfId-8122336]Although Cisco strongly recommends that you keep the default setting, if the management port conflicts with other communications on your network, you can choose a different port. Usually, changes to the management port are made during installation of the FireSIGHT System.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8122340] 
      Caution If you change the management port, you must change it for all appliances in your deployment that need to communicate with each other. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8122341]To change the management port:
 
     [bookmark: pgfId-8122345]Access: Admin
 
     
 
     [bookmark: pgfId-8122346]Step 1 On the web interface for the device, select System > Local > Configuration.
 
     [bookmark: pgfId-8122347]The Information page appears.
 
     [bookmark: pgfId-8122348]Step 2 Click Network.
 
     [bookmark: pgfId-8122349]The Network Settings page appears.
 
     [bookmark: pgfId-8122350]Step 3 In the Remote Management Port field, enter the port number that you want to use.
 
     [bookmark: pgfId-8122351]Step 4 Click Save.
 
     [bookmark: pgfId-8122352]The management port is changed. 
 
     [bookmark: pgfId-8122353]Step 5 Repeat this procedure for every appliance in your deployment that must communicate with this appliance.
 
     [bookmark: pgfId-8122354]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7260320][bookmark: 29062]Adding [bookmark: marker-7260315]Devices to the Defense Center
 
     [bookmark: pgfId-7260321]License: Any
 
     [bookmark: pgfId-8122808]When you manage a device, you set up a two-way, SSL-encrypted communication channel between the Defense Center and the device. The Defense Center uses this channel to send information about how you want to analyze your network traffic to the device. As the device evaluates the traffic, it generates events and sends them to the Defense Center using the same channel. For more information about configuring this channel, see Configuring Remote Management.
 
     [bookmark: pgfId-7794265]Note that you cannot add devices running software more than one major version lower than the Defense Center. For example, if your Defense Center is running Version 5.4, you can add devices running Version 5.3.x or higher but not devices running Version 5.2.x.
 
     [bookmark: pgfId-7178590]Before you manage a device with a Defense Center, you must make sure that the network settings are configured correctly on the device. This is usually completed as part of the installation process. See Configuring Management Interfaces for more information.
 
     [bookmark: pgfId-7313082]Note that if you registered a Defense Center and a device using IPv4 and want to convert them to IPv6, you must delete and re-register the device.
 
     [bookmark: pgfId-7582093]When you register a managed device to a Defense Center, you can select an access control policy to apply to the device. However, if the device is incompatible with the policy, the policy apply fails. This incompatibility could occur for multiple reasons, including licensing mismatches, model restrictions, passive vs inline issues, and other misconfigurations. If the initial access control policy apply fails, the initial network discovery policy apply also fails. After you resolve the issue that caused the failure, you must manually apply access control and network discovery policies to the device. For more information on issues that could cause access control policy apply to fail, see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-8073962]When you register a device cluster or device stack, although you can select licenses, these licenses cannot be applied upon device registration. This ensures that the cluster or stack is running the proper licenses to prevent it from entering a degraded state with mismatched licenses. After registration, you can evaluate the licenses in either the general properties (cluster) or stack properties (stack) of the Device Management page. For more information, see Establishing Device Clusters or Establishing Device Stacks.
 
     [bookmark: pgfId-7619343]When you register a Series 2 device, although you can select licenses, any licenses you select are not applied upon device registration. Series 2 devices automatically have Protection capabilities, with the exception of Security Intelligence filtering. You cannot disable these capabilities, nor can you apply other licenses to a Series 2 device.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7627307]To add a device to a Defense Center:
 
    [bookmark: pgfId-8122945]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-8122949]Step 1 Configure the device to be managed by the Defense Center.
 
    [bookmark: pgfId-8122956]For FirePOWER devices, use the procedure in Configuring Remote Management. After the device confirms communication with the Defense Center, the Pending Registration status appears.
 
    [bookmark: pgfId-8191637]For virtual devices, Cisco NGIPS for Blue Coat X-Series, and ASA FirePOWER devices, configure remote management using the device’s command line interface (CLI).
 
     
      
    
 
    
 
    [bookmark: pgfId-7178713]Note In some high availability deployments where network address translation (NAT) is used, you may also need to add the secondary Defense Center as a manager. For more information, contact Support.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7178775]Step 2 On the web interface for the Defense Center, select Devices > Device Management.
 
    [bookmark: pgfId-7312307]The Device Management page appears.
 
    [bookmark: pgfId-7312308]Step 3 From the Add drop-down menu, select Add Device.
 
    [bookmark: pgfId-7312309]The Add Device pop-up window appears.
 
    [bookmark: pgfId-7178783]Step 4 In the Host field, type the IP address or the hostname of the device you want to add.
 
    [bookmark: pgfId-7178784]The hostname of the device is the fully qualified domain name or the name that resolves through the local DNS to a valid IP address.
 
    [bookmark: pgfId-7178785]Note that in a NAT environment, you may not need to specify the IP address or host name of the device, if you already specified the IP address or host name of the Defense Center when you configured the device to be managed by the Defense Center. For more information, see Working in NAT Environments.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7178795] 
     Caution Use a hostname rather than an IP address if your network uses DHCP to assign IP addresses. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7178796]Step 5 In the Registration Key field, type the same registration key that you used when you configured the device to be managed by the Defense Center.
 
    [bookmark: pgfId-7178800]Step 6 Optionally, add the device to a device group by selecting the group from the Group drop-down list.
 
    [bookmark: pgfId-7184981]For more information about device groups, see Managing Device Groups.
 
    [bookmark: pgfId-7185036]Step 7 From the Access Control Policy drop-down list, select an initial policy to apply to the device:
 
     
      
      	 [bookmark: pgfId-7192113]The  Default Access Control policy blocks all traffic from entering your network.
 
      	 [bookmark: pgfId-7584431]The  Default Intrusion Prevention policy allows all traffic that is also passed by the Balanced Security and Connectivity intrusion policy.
 
      	 [bookmark: pgfId-7585688]The  Default Network Discovery policy allows all traffic, which is inspected by network discovery only.
 
      	 [bookmark: pgfId-7212722]You can select any existing user-defined access control policy.
 
     
 
    
 
    [bookmark: pgfId-7585872]For more information, see Managing Access Control Policies.
 
    [bookmark: pgfId-7185223]Step 8 Select licenses to apply to the device. Note that:
 
     
      
      	 [bookmark: pgfId-7582609]Control, Malware, and URL Filtering licenses require a Protection license.
 
      	 [bookmark: pgfId-8177687]You cannot enable a VPN license on a virtual device, Cisco NGIPS for Blue Coat X-Series, or ASA FirePOWER device.
 
      	 [bookmark: pgfId-8179131]You cannot enable a Control license on Cisco NGIPS for Blue Coat X-Series.
 
      	 [bookmark: pgfId-8177697]Although you can enable a Control license on a virtual device or ASA FirePOWER device, these devices do  not support fast-path rules, switching, routing, stacking, or clustering.
 
      	 [bookmark: pgfId-7584096]You cannot change the license settings on clustered devices.
 
      	 [bookmark: pgfId-7619155]For stacked devices, you enable or disable the licenses for the stack on the Stack page of the appliance editor.
 
      	 [bookmark: pgfId-7619253]When you register a Series 2 device, any licenses you select are not applied upon device registration. Series 2 devices automatically have Protection capabilities, with the exception of Security Intelligence filtering. You cannot disable these capabilities, nor can you apply other licenses to a Series 2 device.
 
     
 
    
 
    [bookmark: pgfId-7619137]For more information, see Licensing the FireSIGHT System.
 
    [bookmark: pgfId-7184802]Step 9 If you used a NAT ID to identify the device when you configured it to be managed by the Defense Center, expand the Advanced section and enter the same NAT ID in the Unique NAT ID field.
 
    [bookmark: pgfId-7185668]Step 10 To allow the device to transfer packets to the Defense Center, select the Transfer Packets check box.
 
    [bookmark: pgfId-7188252]This option is enabled by default. If you disable it, you completely prohibit packet transfer to the Defense Center.
 
    [bookmark: pgfId-7178933]Step 11 Click Register.
 
    [bookmark: pgfId-7178937]The device is added to the Defense Center. Note that it may take up to two minutes for the Defense Center to verify the device’s heartbeat and establish communication.
 
    [bookmark: pgfId-7876294]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7211484][bookmark: 33601]Applying Changes to Devices
 
    [bookmark: pgfId-7208695]License: Any
 
    [bookmark: pgfId-7796521]After you make changes to the configuration of a device, a device cluster, or a device stack, you must apply the changes before they take effect throughout the system. Note that the device must have unapplied changes or this option remains disabled.
 
     
      
    
 
    
 
    [bookmark: pgfId-7796523]Tip You can apply device changes from the Device Management page or from the Interfaces tab of the appliance editor.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7208697]To apply changes to the device:
 
    [bookmark: pgfId-7208723]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7213451]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7213452]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7482819]Step 3 When prompted, click Apply.
 
    [bookmark: pgfId-7214316]The device changes are applied.
 
     
      
    
 
    
 
    [bookmark: pgfId-7214323]Tip Optionally, from the Apply Device Changes dialog box, click View Changes. The Device Management Revision Comparison Report page appears in a new browser window. For more information, see Using the Device Management Revision Comparison Report.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7214705]Step 4 Click OK.
 
    [bookmark: pgfId-7214759]You are returned to the Device Management page.
 
    [bookmark: pgfId-7876391]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7208680][bookmark: 37619]Using the Device Management Revis[bookmark: marker-7368489]ion Comparison Report
 
    [bookmark: pgfId-7214662]License: Any
 
    [bookmark: pgfId-7214908]A device management comparison report allows you to view the changes you have made to an appliance before you apply them. The report displays all differences between the current appliance configuration and the proposed appliance configuration. This gives you an opportunity to discover any potential configuration errors.
 
    [bookmark: pgfId-7214917]To compare appliance changes before applying them:
 
    [bookmark: pgfId-7214918]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7214919]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7214920]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7246795]The Apply Device Changes pop-up window appears. Note that the appliance must have unapplied changes or the apply icon remains disabled.
 
    [bookmark: pgfId-7215283]Step 3 Click View Changes.
 
    [bookmark: pgfId-7215284]The Device Management Revision Comparison Report page appears in a new window.
 
    [bookmark: pgfId-7215288]Step 4 Click Previous and Next to scroll through the differences between the current appliance configuration and the proposed appliance configuration.
 
    [bookmark: pgfId-7345916]Step 5 Optionally, click Comparison Report to produce a PDF version of the report.
 
    [bookmark: pgfId-7876407]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7214911][bookmark: 25370]Deleting [bookmark: marker-7214910]Devices
 
    [bookmark: pgfId-7212313]License: Any
 
    [bookmark: pgfId-7314424]If you no longer want to manage a device, you can delete it from the Defense Center. Deleting a device severs all communication between the Defense Center and the device. To manage the device again at a later date, you must re-add it to the Defense Center.
 
     
      
    
 
    
 
    [bookmark: pgfId-7314435]Note If you delete a device from a Defense Center configured in a high availability pair and want to re-add it, Cisco recommends that you wait at least five minutes before re-adding it. This interval ensures that the high availability pair resynchronizes so that both Defense Centers recognize the deletion. If you do not wait five minutes, it may take more than one synchronization cycle to add the device to both Defense Centers.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7179304][bookmark: 99051]To delete a device from the Defense Center:
 
    [bookmark: pgfId-7179305]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7179306]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7179307]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7264540]When prompted, confirm that you want to delete the device. Communication between the device and the Defense Center is discontinued and the device is deleted from the Device Management page. If the device has a system policy that causes it to receive time from the Defense Center via NTP, the device reverts to local time management.
 
    [bookmark: pgfId-7876455]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8109138][bookmark: 75349][bookmark: 98813][bookmark: 91405]Managing Device[bookmark: marker-7180257] Groups
 
    [bookmark: pgfId-7247658]License: Any
 
    [bookmark: pgfId-7180262]The Defense Center allows you to group devices so you can easily apply policies and install updates on multiple devices. You can expand and collapse the list of devices in the group. The list appears collapsed by default.
 
    [bookmark: pgfId-7188609]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7188613]Adding Device Groups
 
     	 [bookmark: pgfId-7180274]Editing Device Groups
 
     	 [bookmark: pgfId-7188643]Deleting Device Groups
 
    
 
     
      [bookmark: pgfId-7188645][bookmark: 50130]Adding Devic[bookmark: marker-7371884]e Groups
 
     [bookmark: pgfId-7247630]License: Any
 
     [bookmark: pgfId-7794229]The following procedure explains how to add a device group so you can easily apply policies and install updates on multiple devices.
 
     [bookmark: pgfId-7794230]If you add the primary device in a stack or a cluster to a group, both devices are added to the group. If you unstack or uncluster the devices, both devices remain in that group.
 
     [bookmark: pgfId-7794231]To create a device group and add devices to it:
 
     [bookmark: pgfId-7180429]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7180433]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7180434]The Device Management page appears.
 
     [bookmark: pgfId-7312427]Step 2 From the Add drop-down menu, select Add Group.
 
     [bookmark: pgfId-7188761]The Add Group pop-up window appears.
 
     [bookmark: pgfId-7180490]Step 3 In the Name field, type the name of the group.
 
     [bookmark: pgfId-7218168]Step 4 Under Available Devices, select one or more appliances to add to the device group. Use Ctrl or Shift while clicking to select multiple appliances.
 
     [bookmark: pgfId-7218426]Step 5 Click Add to include the selected appliances in the device group.
 
     [bookmark: pgfId-7219156]Step 6 Click OK.
 
     [bookmark: pgfId-7219157]The device group is added.
 
     [bookmark: pgfId-7876515]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7219163][bookmark: 94741][bookmark: marker-7219159][bookmark: 80252]Editing Device [bookmark: marker-7219161]Groups
 
     [bookmark: pgfId-7247616]License: Any
 
     [bookmark: pgfId-7211989]You can change the set of devices that reside in any device group. You must remove an appliance from its current group before you can add it to a new group.
 
     [bookmark: pgfId-7247380]Moving an appliance to a new group does not change its policy to the policy previously applied to the group. To change the device’s policy, you must apply a new policy to the device or device group. 
 
     [bookmark: pgfId-7794511]Note that if you add the primary device in a stack or a cluster to a group, both devices are added to the group. If you unstack or uncluster the devices, both devices remain in that group.
 
     [bookmark: pgfId-7180583]To edit a device group:
 
     [bookmark: pgfId-7180584]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7218700]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7218701]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7219173]The Edit Group pop-up window appears.
 
     [bookmark: pgfId-7219178]Step 3 Optionally, in the Name field, type a new name for the group
 
     [bookmark: pgfId-7219052]Step 4 Under Available Devices, select one or more appliances to add to the device group. Use Ctrl or Shift while clicking to select multiple appliances.
 
     [bookmark: pgfId-7219227]Step 5 Click Add to include the selected appliances in the device group.
 ). 
     
 
     [bookmark: pgfId-7219229]Step 7 Click OK.
 
     [bookmark: pgfId-7219230]The changes to the device group are saved.
 
     [bookmark: pgfId-7876538]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7180738][bookmark: 15305]Deleting Dev[bookmark: marker-7371896]ice Groups
 
     [bookmark: pgfId-7247585]License: Any
 
     [bookmark: pgfId-7198845]If you delete a device group that contains devices, the devices are moved to the Ungrouped category on the Device Management page. They are not deleted from the Defense Center.
 
     [bookmark: pgfId-7198849]To delete a device group:
 
     [bookmark: pgfId-7180744]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7180745]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7180746]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7189368]Step 3 When prompted, confirm that you want to delete the device group.
 
     [bookmark: pgfId-7219383]The device group is deleted.
 
     [bookmark: pgfId-7876689]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7220007][bookmark: 39883]Clusterin[bookmark: marker-7371920]g Devices
 
    [bookmark: pgfId-7220008]License: Control
 
    [bookmark: pgfId-7622520]Supported Devices: Series 3
 
    [bookmark: pgfId-7220009]With device clustering (also called device high availability), you can establish redundancy of networking functionality and configuration data between two peer devices or two peer device stacks. See Managing Stacked Devices for more information about stacking devices.
 
    [bookmark: pgfId-7263562]You achieve configuration redundancy by clustering two peer devices or two peer device stacks as a single logical system for policy applies, system updates, and registration. The system automatically synchronizes other configuration data.
 
    [bookmark: pgfId-7711929]Clustering Requirements
 
    [bookmark: pgfId-7715176]Before you can configure a device cluster, both devices or device stack primary members must be the same model and have identical copper or fiber interfaces. Both devices or device stacks must also be running the same software and have the same licenses. Device stacks must have identical hardware configurations, except for an installed [bookmark: marker-7805037][bookmark: marker-7805067]malware storage pack. For example, you can cluster a 3D8290 with a 3D8290; none, one, or all devices in either stack might have a malware storage pack. If the devices are targeted by NAT policies, both peers must have the same NAT policy. After you cluster the devices, you cannot change the license options for individual clustered devices, but you can change the license for the entire cluster. See Establishing Device Clusters for more information.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7802520] 
     Caution Do not attempt to install a hard drive that was not supplied by Cisco in your device. Installing an unsupported hard drive may damage the device. Malware storage pack kits are available for purchase 
     only from Cisco, and are for use 
     only with 8000 Series devices. Contact Support if you require assistance with the malware storage pack. See the 
       
     FireSIGHT System 
      Malware Storage Pack Guide for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7685399]Clustering Failover and Maintenance Mode
 
    [bookmark: pgfId-8149483]With a device cluster, the system fails over either manually or automatically. You manually trigger failover by placing one of the clustered devices or stacks in maintenance mode. For more information about maintenance mode, see Placing a Clustered Device into Maintenance Mode.
 
    [bookmark: pgfId-8142832]Automatic failover occurs after the health of the active device or stack becomes compromised, during a system update, or after a user with Administrator privileges shuts down the device. Automatic failover also occurs after an active device or device stack experiences NMSB failure, NFE failure, hardware failure, firmware failure, critical process failure, a disk full condition, or link failure between two stacked devices. If the health of the backup device or stack becomes similarly compromised, the system does not fail over and enters a degraded state. The system also does not fail over when one of the devices or device stacks is in maintenance mode. Note that disconnecting the stacking cable from an active stack sends that stack into maintenance mode. Shutting down the secondary device in an active stack also sends that stack into maintenance mode.
 
     
      
    
 
    
 
    [bookmark: pgfId-8143413]Note If the active cluster member goes into maintenance mode and the active role fails over to the other cluster member, when the original active cluster member is restored to normal operation it does not automatically reclaim the active role.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7709660]Applying Policies and Updates
 
    [bookmark: pgfId-7715280]When you apply policies, you apply them to the device cluster instead of the individual devices or stacks. If the policy fails, the system does not apply it to either device or stack. The policy first applies to the active device or stack and then the backup, so that the cluster always has one peer handling network traffic.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8236657] 
     Caution When you apply policies, resource demands may result in a small number of packets dropping without inspection. Additionally, applying some configurations requires the Snort process to restart, which temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. On 7010, 7020, and 7030 managed devices, deploying configuration changes can take up to five minutes. See 
     Configurations that Restart the Snort Process and 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7277554]Clustered devices receive updates as a single entity rather than individual devices or stacks. When the update is started, the system first applies it to the backup device or stack, which goes into maintenance mode until any necessary processes restart and the device begins processing traffic again. The system then applies the update to the active device or stack, which follows the same process.
 
    [bookmark: pgfId-7263551]Achieving Redundancy Without Clustering Devices
 
    [bookmark: pgfId-7715442]In most cases, you can achieve Layer 3 redundancy without clustering devices by using the Cisco Redundancy Protocol (SFRP). SFRP allows devices to act as redundant gateways for specified IP addresses. With network redundancy, you configure two devices or stacks to provide identical network connections, ensuring connectivity for other hosts on the network. For more information about SFRP, see Configuring SFRP.
 
    [bookmark: pgfId-7263792]You determine how to configure device high availability depending on your FireSIGHT System deployment: passive, inline, routed, or switched. You can also deploy your system in multiple roles at once. Of the four deployment types, only passive deployments require that you cluster devices or stacks to provide redundancy. You can establish network redundancy for the other deployment types with or without device clusters. The following sections provide a brief overview of high availability in each deployment type.
 
    [bookmark: pgfId-7264363]Passive Deployment Redundancy
 
    [bookmark: pgfId-7264402]Passive interfaces are generally connected to tap ports on central switches, which allows them to analyze all of the traffic flowing across the switch. If multiple devices are connected to the same tap feed, the system generates events from each of the devices. When clustered, devices act as either active or backup, which allows the system to analyze traffic even in the event of a system failure while also preventing duplicate events.
 
    [bookmark: pgfId-7264457]Inline Deployment Redundancy
 
    [bookmark: pgfId-7265000]Because an inline set has no control over the routing of the packets being passed through it, it must always be active in a deployment. Therefore, redundancy relies on external systems to route traffic correctly. You can configure redundant inline sets with or without device clusters.
 
    [bookmark: pgfId-7266298]To deploy redundant inline sets, you configure the network topology so that it allows traffic to pass through only one of the inline sets while preventing circular routing. If one of the inline sets fails, the surrounding network infrastructure detects the loss of connectivity to the gateway address and adjusts the routes to send traffic through the redundant set.
 
    [bookmark: pgfId-7265006]Routed Deployment Redundancy
 
    [bookmark: pgfId-7265067]Hosts in an IP network must use a well-known gateway address to send traffic to different networks. Establishing redundancy in a routed deployment requires that routed interfaces share the gateway addresses so that only one interface handles traffic for that address at any given time. To accomplish this, you must maintain an equal number of IP addresses on a virtual router. One interface advertises the address. If that interface goes down, the backup interface begins advertising the address.
 
    [bookmark: pgfId-7267354]In non-clustered devices, you use SFRP to establish redundancy by configuring gateway IP addresses shared between multiple routed interfaces. You can configure SFRP with or without device clusters. You can also establish redundancy using dynamic routing such as OSPF or RIP.
 
    [bookmark: pgfId-7265069]Switched Deployment Redundancy
 
    [bookmark: pgfId-7265112]You establish redundancy in a switched deployment using the Spanning Tree Protocol (STP). STP is a protocol that manages the topology of bridged networks. It is specifically designed to allow redundant links to provide automatic backup for switched interfaces without configuring backup links. Devices in a switched deployment rely on STP to manage traffic between redundant interfaces. Two devices connected to the same broadcast network receive traffic based on the topology calculated by STP. See Configuring Advanced Virtual Switch Settings for more information about enabling STP.
 
     
      
    
 
    
 
    [bookmark: pgfId-7421487]Note Cisco strongly recommends that you enable STP when configuring a virtual switch that you plan to deploy in a device cluster.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7275857]See the following sections for more information about clustering devices and stacks:
 
     
     	 [bookmark: pgfId-7278487]Establishing Device Clusters
 
     	 [bookmark: pgfId-7278491]Editing Device Clusters
 
     	 [bookmark: pgfId-7667364]Configuring Individual Devices in a Cluster
 
     	 [bookmark: pgfId-7674898]Configuring Individual Device Stacks in a Cluster
 
     	 [bookmark: pgfId-7667669]Configuring Interfaces on a Clustered Device
 
     	 [bookmark: pgfId-7663043]Switching the Active Peer in a Cluster
 
     	 [bookmark: pgfId-7663045]Placing a Clustered Device into Maintenance Mode
 
     	 [bookmark: pgfId-7674936]Replacing a Device in a Clustered Stack
 
     	 [bookmark: pgfId-7663047]Establishing Clustered State Sharing
 
     	 [bookmark: pgfId-7663213]Troubleshooting Clustered State Sharing
 
     	 [bookmark: pgfId-7278497]Separating Clustered Devices
 
     	 [bookmark: pgfId-7278503]Configuring SFRP
 
     	 [bookmark: pgfId-7279130]Configuring HA Link Interfaces
 
    
 
     
      [bookmark: pgfId-7278493][bookmark: 27620]Establishing Devi[bookmark: marker-7371925]ce Clusters
 
     [bookmark: pgfId-7622575]License: Control
 
     [bookmark: pgfId-7622608]Supported Devices: Series 3
 
     [bookmark: pgfId-7712723]Before you establish a device cluster, you must meet the following prerequisites:
 
      
      	 [bookmark: pgfId-7715568]Configure interfaces on each device or each primary device in a stack.
 
      	 [bookmark: pgfId-7715577]Each device or device stack primary member that you include in the cluster must be the same model and have identical copper or fiber interfaces.
 
      	 [bookmark: pgfId-7715580]Both devices or device stacks must have normal health status, run the same software, and have the same licenses. See Using the Health Monitor for more information. In particular, the devices cannot have hardware failures that would cause them to enter maintenance mode and trigger a failover. 
 
      	 [bookmark: pgfId-7715592]You cannot mismatch devices and stacks in a cluster. You must cluster single devices with single devices or device stacks with device stacks that have identical hardware configurations, except for the presence of a malware storage pack. For example, you can cluster a 3D8290 with a 3D8290; none, one, or all devices in either stack might have an installed malware storage pack. For more information on the malware storage pack, see the  FireSIGHT System  Malware Storage Pack Guide .
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7802710] 
      Caution Do not attempt to install a hard drive that was not supplied by Cisco in your device. Installing an unsupported hard drive may damage the device. Malware storage pack kits are available for purchase 
      only from Cisco, and are for use 
      only with 8000 Series devices. Contact Support if you require assistance with the malware storage pack. See the 
        
      FireSIGHT System 
       Malware Storage Pack Guide for more information. 
       
       
 
      
 
     
 
      
      	 [bookmark: pgfId-7715595]If the devices are targeted by NAT policies, both peers must have the same NAT policy.
 
     
 
     [bookmark: pgfId-7277093]When establishing a device cluster, you designate one of the devices or stacks as active and the other as backup. The system applies a merged configuration to the clustered devices. If there is a conflict, the system applies the configuration from the device or stack you designated as active.
 
     [bookmark: pgfId-7714367]After you cluster the devices, you cannot change the license options for individual clustered devices, but you can change the license for the entire cluster. See Editing Device Clusters for more information. If there are interface attributes that need to be set on switched interfaces or routed interfaces, the system establishes the cluster, but sets it to a pending status. After you configure the necessary attributes, the system completes the device cluster and sets it to a normal status.
 ) in the appliance list. Any configuration changes you make are synchronized between the clustered devices. The Device Management page displays which device or stack in the cluster is active, which changes after manual or automatic failover. See 
     Placing a Clustered Device into Maintenance Mode for more information about manual failover. 
     
 
     [bookmark: pgfId-7502754]Removing registration of a device cluster from a Defense Center removes registration from both devices or stacks. You remove a device cluster from the Defense Center as you would an individual managed device. See Deleting Devices for more information.
 
     [bookmark: pgfId-7502721]You can then register the cluster on another Defense Center. To register clustered single devices, you add remote management to the active device in the cluster and then add that device to the Defense Center, which adds the entire cluster. To register clustered stacked devices, you add remote management to the primary device of the either stack and then add that device to the Defense Center, which adds the entire cluster. See Adding Devices to the Defense Center for more information.
 
     [bookmark: pgfId-7273105]After you establish a device cluster, you can configure a high availability link interface, as explained in Configuring HA Link Interfaces.
 
     [bookmark: pgfId-7220013]To cluster devices or device stacks:
 
     [bookmark: pgfId-7220014]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7261557]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7270844]The Device Management page appears.
 
     [bookmark: pgfId-7270845]Step 2 From the Add drop-down menu, select Add Cluster.
 
     [bookmark: pgfId-7388237]The Add Cluster pop-up window appears.
 
     [bookmark: pgfId-7388239]Step 3 In the Name field, type the name of the cluster.
 
     [bookmark: pgfId-7717227]You may enter alphanumeric characters and special characters, with the exception of the following characters, which are invalid: +, (, ), {, }, #, &, \, <, >, ?, ‘, and “.
 
     [bookmark: pgfId-7261685]Step 4 Select the Active device or stack for the cluster.
 
     [bookmark: pgfId-7261686]Step 5 Select the Backup device or stack for the cluster.
 
     [bookmark: pgfId-7261567]Step 6 Click Cluster.
 
     [bookmark: pgfId-7261568]The device cluster is added. This process takes a few minutes as the process synchronizes system data.
 
     [bookmark: pgfId-7876705]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7220016][bookmark: 71584]Editing Device Clus[bookmark: marker-7371930]ters
 
     [bookmark: pgfId-7388324]License: Control
 
     [bookmark: pgfId-7622634]Supported Devices: Series 3
 
     [bookmark: pgfId-7648259]After you establish a device cluster, most changes you make to the device configuration also change the configuration of the entire cluster.
 
     [bookmark: pgfId-7663802]You can view the status of the cluster by hovering your pointer over the status icon in the General section. You can also view which device or stack is the active peer and backup peer in the cluster.
 
     [bookmark: pgfId-7808557]See the following sections for more information:
 
      
      	 [bookmark: pgfId-8093261]Editing General Device Settings
 
      	 [bookmark: pgfId-7808565]Enabling and Disabling Device Licenses
 
      	 [bookmark: pgfId-7808569]Establishing Clustered State Sharing
 
      	 [bookmark: pgfId-7808573]Editing Advanced Device Settings
 
     
 
     [bookmark: pgfId-7220019]To edit a device cluster:
 
     [bookmark: pgfId-7220020]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7664343]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7664344]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7716405]The Cluster page appears.
 
     [bookmark: pgfId-7664350]Step 3 Use the sections on the Cluster page to make changes to the clustered configuration as you would a single device configuration.
 
     [bookmark: pgfId-7876734]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7666801][bookmark: 85309]Con[bookmark: marker-7722164]figuring Individual Devices in a Cluster
 
     [bookmark: pgfId-7666852]License: Control
 
     [bookmark: pgfId-7666876]Supported Devices: Series 3
 
     [bookmark: pgfId-7714535]After you establish a device cluster, you can still configure some attributes for each device within the cluster. You can make changes to a clustered device just as you would to a single device.
 
     [bookmark: pgfId-7808894]See the following sections for more information:
 
      
      	 [bookmark: pgfId-8093369]Editing General Device Settings
 
      	 [bookmark: pgfId-7808902]Editing Device System Settings
 
      	 [bookmark: pgfId-7808906]Viewing the Health of a Device
 
      	 [bookmark: pgfId-7808910]Editing Device Management Settings
 
     
 
     [bookmark: pgfId-7667224]To configure an individual device in a cluster:
 
     [bookmark: pgfId-7667225]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7667226]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7667227]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7667232]The Cluster page appears.
 
     [bookmark: pgfId-7667233]Step 3 Click Devices.
 
     [bookmark: pgfId-7716714]The Devices page appears.
 
     [bookmark: pgfId-7667235]Step 4 From the Selected Device drop-down list, select the device you want to modify.
 
     [bookmark: pgfId-7667236]Step 5 Use the sections on the Devices page to make changes to the individual clustered device as you would a single device.
 
     [bookmark: pgfId-7876750]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7671320][bookmark: 20056]Con[bookmark: marker-7722190]figuring Individual Device Stacks in a Cluster
 
     [bookmark: pgfId-7671405]License: Control
 
     [bookmark: pgfId-7671419]Supported Devices: Series 3
 
     [bookmark: pgfId-7671504]After you cluster a pair of stacked devices, the system limits the stack attributes that you can edit. You can edit the name of a stack in a clustered stack. In addition, you can edit the network configuration of the stack, as described in Configuring Interfaces on a Clustered Device.
 
     [bookmark: pgfId-7672048]To edit the name of a stack in a cluster:
 
     [bookmark: pgfId-7672049]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7672050]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7672051]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7672056]The Cluster page appears.
 
     [bookmark: pgfId-7672057]Step 3 Click Stacks.
 
     [bookmark: pgfId-7672058]The Stacks page appears.
 
     [bookmark: pgfId-7716850]From the Selected Device drop-down list, select the stack you want to modify.
 ). 
     
 
     [bookmark: pgfId-7714899]You may enter alphanumeric characters and special characters, with the exception of the following characters, which are invalid: +, (, ), {, }, #, &, \, <, >, ?, ‘, and “.
 
     [bookmark: pgfId-7672257]Step 6 Click Save.
 
     [bookmark: pgfId-7722493]The new name is saved. Note that your changes do not take effect until you apply the stack configuration; see Applying Changes to Devices for more information.
 
     [bookmark: pgfId-7876852]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7722500][bookmark: 84701]Config[bookmark: marker-7722498]uring In[bookmark: marker-7722499]terfaces on a Clustered Device
 
    [bookmark: pgfId-7722504]License: Control
 
    [bookmark: pgfId-7667502]Supported Devices: Series 3
 
    [bookmark: pgfId-7667503]You can configure interfaces on individual devices in a cluster. However, you must also configure an equivalent interface on the peer device in the cluster. For clustered stacks, you configure identical interfaces on the primary devices of the stacks. When you configure virtual routers, you select the stack where you want to configure the routers. See Configuring Virtual Routers for more information.
 
    [bookmark: pgfId-7667510]The Interfaces page of a clustered device includes the hardware and interfaces views that you find on an individual device. See Configuring Sensing Interfaces for more information.
 
    [bookmark: pgfId-7667514]To configure interfaces on a clustered device:
 
    [bookmark: pgfId-7667515]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7667516]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7667517]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7667522]The Cluster page appears.
 
    [bookmark: pgfId-7667523]Step 3 Click Interfaces.
 
    [bookmark: pgfId-7718231]The Interfaces page appears.
 
    [bookmark: pgfId-7667525]Step 4 From the Selected Device drop-down list, select the device you want to modify.
 
    [bookmark: pgfId-7667528]Step 5 Configure interfaces as you would on an individual device. See Configuring Sensing Interfaces for more information.
 
    [bookmark: pgfId-7876872]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7647100][bookmark: 98442]Switching the A[bookmark: marker-7722273]ctive Peer in a Cluster
 
    [bookmark: pgfId-7647176]License: Control
 
    [bookmark: pgfId-7647222]Supported Devices: Series 3
 
    [bookmark: pgfId-7653061]After you establish a device cluster, you can manually switch the active and backup peer devices or stacks.
 
    [bookmark: pgfId-7664961]To switch the active peer in a cluster:
 
    [bookmark: pgfId-7665005]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7652883]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7652884]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7718298]The Switch Active Peer pop-up window appears.
 
    [bookmark: pgfId-7652897]Step 3 Click Yes to immediately make the backup device the active device in the cluster. Click No to cancel and return to the Device Management page.
 
    [bookmark: pgfId-7876892]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7662916][bookmark: 73541]Placing a C[bookmark: marker-7722294]lustered Device into Maintenance Mode
 
    [bookmark: pgfId-7662920]License: Control
 
    [bookmark: pgfId-7662924]Supported Devices: Series 3
 
    [bookmark: pgfId-7662925]After you establish a cluster, you can manually trigger failover by placing one of the clustered devices or stacks into maintenance mode to perform maintenance on the devices. In maintenance mode, the system administratively takes down all interfaces except for the management interface. After maintenance is completed, you can re-enable the device to resume normal operation.
 
     
      
    
 
    
 
    [bookmark: pgfId-8143668]Note You should not place both members of a cluster into maintenance mode at the same time. Doing so will prevent that cluster from inspecting traffic.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7665692]To place a clustered device into maintenance mode:
 
    [bookmark: pgfId-7728776]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7662926]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7662927]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7718426]The Confirm Maintenance Mode pop-up window appears.
 
    [bookmark: pgfId-7662938]Step 3 Click Yes to confirm maintenance mode or click No to cancel.
 ) again to bring the device out of maintenance mode. 
    
 
    [bookmark: pgfId-7876908]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7673348][bookmark: 80406]Repla[bookmark: marker-7722555]cing a Device in a Clustered Stack
 
    [bookmark: pgfId-7673410]License: Control
 
    [bookmark: pgfId-7673414]Supported Devices: Series 3
 
    [bookmark: pgfId-7673455]After you place a stack that is a cluster member into maintenance mode, you can replace a secondary device in the stack for another device. You can only select devices that are not currently stacked or clustered. The new device must follow the same guidelines for establishing a device stack. See Establishing Device Stacks.
 
    [bookmark: pgfId-7673553]To replace a device in a clustered stack:
 
    [bookmark: pgfId-7728798]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7673554]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7673555]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7673560]The Confirm Maintenance Mode pop-up window appears.
 
    [bookmark: pgfId-7673973]Step 3 Click Yes to confirm maintenance mode or click No to cancel.
 ). 
    
 
    [bookmark: pgfId-7718491]The Replace Device pop-up window appears.
 
    [bookmark: pgfId-7674290]Step 5 Select the Replacement Device from the drop-down list.
 
    [bookmark: pgfId-7674354]Step 6 Click Replace to replace the device or click Cancel to keep the current device and return to the Device Management page.
 ) again to bring the stack immediately out of maintenance mode. 
    
 
    [bookmark: pgfId-7715715]You do not need to reapply the device configuration.
 
    [bookmark: pgfId-7877007]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7613990][bookmark: 18554]Establishing Clustered State Sharing
 
    [bookmark: pgfId-7613933]License: Control
 
    [bookmark: pgfId-7622672]Supported Devices: Series 3
 
    [bookmark: pgfId-7647324]Clustered state sharing allows clustered devices or clustered stacks to synchronize as much state as necessary, so that if either device or stack fails, the other peer can take over with no interruption to traffic flow. Without state sharing, the following features may not fail over properly:
 
     
     	 [bookmark: pgfId-7649239]Strict TCP enforcement
 
     	 [bookmark: pgfId-7649288]Unidirectional access control rules
 
     	 [bookmark: pgfId-7649327]Blocking persistence
 
    
 
    [bookmark: pgfId-7721347]Note, however, that enabling state sharing slows system performance.
 
    [bookmark: pgfId-7721348]You must configure and enable HA link interfaces on both devices or the primary stacked devices in the cluster before you can configure clustered state sharing. 82xx Family and 83xx Family devices require a 10G HA link, while other model devices require a 1G HA link. See Configuring HA Link Interfaces for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-7964016]Note If clustered devices fail over, the system terminates all existing SSL-encrypted sessions on the active device. Even if you establish clustered state sharing, these sessions must be renegotiated on the backup device. If the server establishing the SSL session supports session reuse and the backup device does not have the SSL session ID, it cannot renegotiate the session. For more information, see Clustering Devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7721349]Strict TCP Enforcement
 
    [bookmark: pgfId-7710167]When you enable strict TCP enforcement for a domain, the system drops any packets that are out of order on TCP sessions. For example, the system drops non-SYN packets received on an unestablished connection. With state sharing, devices in the cluster allow TCP sessions to continue after failover without having to reestablish the connection, even if strict TCP enforcement is enabled. You can enable strict TCP enforcement on inline sets, virtual routers, and virtual switches.
 
    [bookmark: pgfId-7710210]Unidirectional Access Control Rules
 
    [bookmark: pgfId-7710211]If you have configured unidirectional access control rules, network traffic may match a different access control rule than intended when the system reevaluates a connection midstream after failover. For example, consider if you have a policy containing the following two access control rules:
 
     
     [bookmark: pgfId-7650654] Rule 1: Allow from 192.168.1.0/24 to 192.168.2.0/24 
    
 
     
     [bookmark: pgfId-7650704] Rule 2: Block all 
    
 
    [bookmark: pgfId-7650792]Without state sharing, if an allowed connection from 192.168.1.1 to 192.168.2.1 is still active following a failover and the next packet is seen as a response packet, the system denies the connection. With state sharing, a midstream pickup would match the existing connection and continue to be allowed.
 
    [bookmark: pgfId-7649579]Blocking Persistence
 
    [bookmark: pgfId-7649663]While many connections are blocked on the first packet based on access control rules or other factors, there are cases where the system allows some number of packets through before determining that the connection should be blocked. With state sharing, the system immediately blocks the connection on the peer device or stack as well.
 
    [bookmark: pgfId-7653385]When establishing clustered state sharing, you can configure the following options:
 
    [bookmark: pgfId-7653513]Enabled
 
    [bookmark: pgfId-7653541]Click the check box to enable state sharing. Clear the check box to disable state sharing.
 
    [bookmark: pgfId-7653591]Minimum Flow Lifetime
 
    [bookmark: pgfId-7653618]Specify the minimum time (in milliseconds) for a session before the system sends any synchronization messages for it. You can use any integer from 0 to 65535. The system does not synchronize any sessions that have not met the minimum flow lifetime, and the system synchronizes only when a packet is received for the connection.
 
    [bookmark: pgfId-7653624]Minimum Sync. Interval
 
    [bookmark: pgfId-7653706]Specify the minimum time (in milliseconds) between update messages for a session. You can use any integer from 0 to 65535. The minimum synchronization interval prevents synchronization messages for a given connection from being sent more frequently than the configured value after the connection reaches the minimum lifetime.
 
    [bookmark: pgfId-7653719]Maximum HTTP URL Length
 
    [bookmark: pgfId-7653746]Specify the maximum characters for the URL the system synchronizes between the clustered devices. You may use any integer from 0 to 225.
 
     
      
    
 
    
 
    [bookmark: pgfId-7661812]Note Cisco recommends that you use the default values, unless your deployment presents a good reason to change them. Decreasing the values allows increased clustered peer readiness, while increasing the values allows better performance.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7652594]To establish clustered state sharing:
 
    [bookmark: pgfId-7652751]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7652977]Step 1 Configure HA link interfaces for each device in the cluster.
 
    [bookmark: pgfId-7653084]See Configuring HA Link Interfaces for more information.
 
    [bookmark: pgfId-7653094]Step 2 Select Devices > Device Management.
 
    [bookmark: pgfId-7652978]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7652983]The Cluster page appears.
 ). 
    
 
    [bookmark: pgfId-7718528]The State Sharing pop-up window appears.
 
    [bookmark: pgfId-7652985]Step 5 Configure the state sharing, as described earlier in this section.
 
    [bookmark: pgfId-7652991]Step 6 Click OK.
 
    [bookmark: pgfId-7654138]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7877033]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7649437][bookmark: 11324]Troubleshooting Clustered State Sharing
 
    [bookmark: pgfId-7649441]License: Control
 
    [bookmark: pgfId-7656285]Supported Devices: Series 3
 
    [bookmark: pgfId-7659984]After you enable state sharing, you can view the following information about the configuration in the State Sharing section of the Cluster page:
 
     
     	 [bookmark: pgfId-7656382]The HA link interface that is being used and its current link state
 
     	 [bookmark: pgfId-7660349]Detailed synchronization statistics for troubleshooting issues
 
    
 
    [bookmark: pgfId-7661307]The state sharing statistics are primarily counters for different aspects of the clustered synchronization traffic sent and received, along with some other error counters. In addition, you can view the latest system logs for each device in the cluster.
 
    [bookmark: pgfId-7661308]See the following sections for more information about the statistics you can view for each device and how you can use them to troubleshoot your clustered state sharing configuration.
 
    [bookmark: pgfId-7675981]Messages Received (Unicast)
 
    [bookmark: pgfId-7676021]Messages received are the number of cluster synchronization messages received from the clustered peer.
 
    [bookmark: pgfId-7711137]The value should be close to the number of messages sent by the peer. During active use, the values may not match, but should be close. If traffic stops, the values should become stable and the messages received will match the messages sent.
 
    [bookmark: pgfId-7711157]For troubleshooting, you should view both the messages received and the messages sent, compare the rate of increase, and make sure the values are close. The sent value on each peer should be incrementing at approximately the same rate as the received value on the opposite peer.
 
    [bookmark: pgfId-7711163]Contact Support if the received messages stop incrementing or increment slower than the messages sent by the peer.
 
    [bookmark: pgfId-7677212]Packets Received
 
    [bookmark: pgfId-7677230]The system batches multiple messages into single packets in order to decrease overhead. The Packets Received counter displays the total number of these data packets, as well as other control packets that have been received by a device.
 
    [bookmark: pgfId-7710959]The value should be close to the number of packets sent by the peer device. During active use, the values may not match, but should be close. Because the number of messages received should be close and incrementing at the same rate as the number of messages sent by the peer, the number of packets received should have the same behavior.
 
    [bookmark: pgfId-7711183]For troubleshooting, you should view both the packets received and the messages sent, compare the rate of increase, and make sure the values are increasing at the same rate. If the sent value on the clustered peer is incrementing, the received value on the device should also increase at the same rate.
 
    [bookmark: pgfId-7711189]Contact Support if the received packets stop incrementing or increment slower than the messages sent by the peer.
 
    [bookmark: pgfId-7677244]Total Bytes Received
 
    [bookmark: pgfId-7677266]Total bytes received are the number of bytes that make up the packets received by the peer.
 
    [bookmark: pgfId-7711195]The value should be close to the number of bytes sent by the other peer. During active use, the values may not match, but should be close. 
 
    [bookmark: pgfId-7711389]For troubleshooting, you should view both the total bytes received and the messages sent, compare the rate of increase, and make sure the values are increasing at the same rate. If the sent value on the clustered peer is incrementing, the received value on the device should also increase at the same rate. 
 
    [bookmark: pgfId-7711213]Contact Support if the received bytes stop incrementing or increment slower than the messages sent by the peer.
 
    [bookmark: pgfId-7710702]Protocol Bytes Received
 
    [bookmark: pgfId-7710698]Protocol bytes received are the number of bytes of protocol overhead received, which includes everything but the payload of session state synchronization messages.
 
    [bookmark: pgfId-7711307]The value should be close to the number of bytes sent by the peer. During active use, the values may not match, but should be close.
 
    [bookmark: pgfId-7711418]For troubleshooting, you should view the total bytes received to discover how much actual state data is being shared in comparison to protocol data. If the protocol data is a large percentage of the data being sent, you can adjust the minimum sync interval.
 
    [bookmark: pgfId-7711424]Contact Support if the protocol bytes received increment at a similar rate to the total bytes received. Protocol bytes received should be minimal in relation to the total bytes received.
 
    [bookmark: pgfId-7677268]Messages Sent
 
    [bookmark: pgfId-7683884]Messages sent are the number of cluster synchronization messages sent to the clustered peer. 
 
    [bookmark: pgfId-7711486]This data is useful in comparison to the number of messages received. During active use, the values may not match, but should be close. 
 
    [bookmark: pgfId-7711492]For troubleshooting, you should view both the messages received and the messages sent, compare the rate of increase, and make sure the values are close.
 
    [bookmark: pgfId-7711498]Contact Support if the messages sent increment at a similar rate to the total bytes received.
 
    [bookmark: pgfId-7683885]Bytes Sent
 
    [bookmark: pgfId-7677302]Bytes sent are the total number of bytes sent that make up the cluster synchronization messages sent to the peer. 
 
    [bookmark: pgfId-7711504]This data are useful in comparison to the number of messages received. During active use, the values may not match, but should be close. The number of bytes received on the peer should be close to, but not more than this value. 
 
    [bookmark: pgfId-7711523]Contact Support if the total bytes received is not incrementing at about the same rate as the bytes sent.
 
    [bookmark: pgfId-7677308]Tx Errors
 
    [bookmark: pgfId-7677319]Tx errors are the number of memory allocation failures the system encounters when trying to allocate space for messages to be sent to the clustered peer.
 
    [bookmark: pgfId-7711541]This value should be zero at all times on both peers. Contact Support if this number is not zero or if the number steadily increases, which indicates the system has encountered an error where it cannot allocate memory.
 
    [bookmark: pgfId-7677321]Tx Overruns
 
    [bookmark: pgfId-7677363]Tx overruns are the number of times the system attempts and fails to place a message into the transit queue.
 
    [bookmark: pgfId-7711430]This value should be zero at all times on both peers. When the value is not zero or is steadily increasing, it indicates that the system is sharing too much data across the HA link that cannot be sent quickly enough.
 
    [bookmark: pgfId-7722090]You should increase the HA link MTU if it was previously set below the default value (9918 or 9922). You can change the minimum flow lifetime and minimum synchronization interval settings to reduce the amount of data shared across the HA link to prevent the number from incrementing.
 
    [bookmark: pgfId-7711448]Contact Support if this value persists or continues to increase.
 
    [bookmark: pgfId-7677373]Recent Logs
 
    [bookmark: pgfId-7677410]The system log displays the most recent clustered synchronization messages. The log should not display any ERROR or WARN messages. It should remain comparable between the peers, such as the same number of sockets being connected. 
 
    [bookmark: pgfId-7711458]However, the data displayed may be opposite in some instances, for example, one peer reports that it received a connection from the other peer and references different IP addresses. The log provides a comprehensive view of the clustered state sharing connection, and any errors within the connection. 
 
    [bookmark: pgfId-7711472]Contact Support if the log displays an ERROR or WARN message, or any message that does not appear to be purely informational.
 
    [bookmark: pgfId-7655078]To view clustered state sharing statistics:
 
    [bookmark: pgfId-7655150]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7655151]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7655083]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7655088]The Cluster page for the device cluster appears.
 ). 
    
 
    [bookmark: pgfId-7716017]The State Sharing Statistics pop-up window appears.
 
    [bookmark: pgfId-7657027]Step 4 Optionally, select a Device to view if your cluster is composed of device stacks.
 
    [bookmark: pgfId-7656451]Step 5 Optionally, click Refresh to update the statistics.
 
    [bookmark: pgfId-7656452]Step 6 Optionally, click View to view the latest data log for each clustered device.
 
    [bookmark: pgfId-7877049]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7612964][bookmark: 41340]Separating Clust[bookmark: marker-7612963]ered Devices
 
    [bookmark: pgfId-7612968]License: Control
 
    [bookmark: pgfId-7622747]Supported Devices: Series 3
 
    [bookmark: pgfId-7220024]When you break device clustering, the active device or stack retains full deployment functionality. The backup device or stack loses its interface configurations and fails over to the active device or stack, unless you choose to leave the interface configurations active, in which case the backup device or stack resumes normal operation. Breaking a cluster always removes the configuration of passive interfaces on the backup devices. Any devices in maintenance mode resume normal operation upon breaking the cluster.
 
    [bookmark: pgfId-7220025]To separate a clustered device:
 
    [bookmark: pgfId-7220026]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7261881]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7261882]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7718593]The Confirm Break pop-up window appears.
 
    [bookmark: pgfId-7271870]Step 3 Optionally, select the check box to remove the interface configurations on the backup device or stack, which means all interfaces except for the management interface are administratively taken down.
 
    [bookmark: pgfId-7272052]Step 4 Click Yes.
 
    [bookmark: pgfId-7272125]The device cluster is separated.
 
    [bookmark: pgfId-7877081]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7471375][bookmark: 54931]Mana[bookmark: marker-7535563]ging Stac[bookmark: marker-7534045]ked Devices
 
    [bookmark: pgfId-8213752]License: Any
 
    [bookmark: pgfId-8213756]Supported Devices: 3D8140, 3D8200 family, 3D8300 family, AMP8300 family, ASM3D9900
 
    [bookmark: pgfId-8213757]You can increase the amount of traffic inspected on a network segment by using devices in a stacked configuration. For each stacked configuration, all devices in the stack must have the same hardware. However, if the stack does not contain a 3D9900, none, some, or all devices might have an installed [bookmark: marker-8213758]malware storage pack. The devices must also be from the same device family based on the following stacked configurations:
 
    [bookmark: pgfId-7809253]For Series 2 and the 81xx Family:
 
     
     	 [bookmark: pgfId-7535843]two 3D8140s
 
     	 [bookmark: pgfId-7741874]two 3D9900s
 
    
 
    [bookmark: pgfId-7741878]For the 82xx Family:
 
     
     	 [bookmark: pgfId-7741879]up to four 3D8250s
 
     	 [bookmark: pgfId-7535845]a 3D8260 (a primary device and a secondary device)
 
     	 [bookmark: pgfId-7535846]a 3D8270 (a primary device with 40G capacity and two secondary devices)
 
     	 [bookmark: pgfId-7741858]a 3D8290 (a primary device with 40G capacity and three secondary devices)
 
    
 
    [bookmark: pgfId-7741862]For the 83xx Family:
 
     
     	 [bookmark: pgfId-7741863]up to four 3D8350s
 
     	 [bookmark: pgfId-7741694]a 3D8360 (a primary device with 40G capacity and a secondary device)
 
     	 [bookmark: pgfId-7741695]a 3D8370 (a primary device with 40G capacity and two secondary devices)
 
     	 [bookmark: pgfId-7741696]a 3D8390 (a primary device with 40G capacity and three secondary devices)
 
     	 [bookmark: pgfId-8212904]up to four AMP8350s
 
     	 [bookmark: pgfId-8212982]an AMP8360 (a primary device with 40G capacity and a secondary device)
 
     	 [bookmark: pgfId-8213020]an AMP8370 (a primary device with 40G capacity and two secondary devices)
 
     	 [bookmark: pgfId-8213048]an AMP8390 (a primary device with 40G capacity and three secondary devices)
 
    
 
    [bookmark: pgfId-7741684]For more information about stacked configurations, see the FireSIGHT System Installation Guide. For more information about the malware storage pack, see the FireSIGHT System Malware Storage Pack Guide.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7802236] 
     Caution Do not attempt to install a hard drive that was not supplied by Cisco in your device. Installing an unsupported hard drive may damage the device. Malware storage pack kits are available for purchase 
     only from Cisco, and are for use 
     only with 8000 Series devices. Contact Support if you require assistance with the malware storage pack. See the 
       
     FireSIGHT System 
      Malware Storage Pack Guide for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7535838]When you establish a stacked configuration, you combine the resources of each stacked device into a single, shared configuration.
 
    [bookmark: pgfId-7471383]You designate one device as the primary[bookmark: marker-7471382] device, where you configure the interfaces for the entire stack. You designate the other devices as secondary. Secondary devices must not be currently sensing any traffic and must not have link on any interface.
 
    [bookmark: pgfId-7471384]Connect the primary device to the network segment you want to analyze in the same way you would configure a single device. See Configuring Sensing Interfaces for more information. Connect the second[bookmark: marker-7471385]ary devices to the primary device using the stacked device cabling instructions found in the FireSIGHT System Installation Guide.
 
    [bookmark: pgfId-7537826]All devices in the stacked configuration must have the same hardware, run the same software version, and have the same licenses. If the devices are targeted by NAT policies, both the primary and secondary device must have the same NAT policy. See Managing NAT Policies for more information. You must apply updates to the entire stack from the Defense Center. If an update fails on one or more devices in the stack, the stack enters a mixed-version state. You cannot apply policies to or update a stack in a mixed-version state. To correct this state, you can break the stack or remove individual devices with different versions, update the individual devices, then reestablish the stacked configuration. After you stack the devices, you can change the licenses only for the entire stack at once.
 
    [bookmark: pgfId-7471397]After you establish the stacked configuration, the devices act like a single, shared configuration. If the pr[bookmark: marker-7471401]imary device fails, no traffic is passed to the secondary devices. Health alerts are generated indicating that the stacking heartbeat has failed on the secondary devices. See Using Health Monitoring for more information.
 
    [bookmark: pgfId-8166354]If the secondary device in a stack fails, inline sets with configurable bypass enabled go into bypass mode on the primary device. For all other configurations, the system continues to load balance traffic to the failed secondary device. In either case, a health alert is generated to indicate loss of link.
 
    [bookmark: pgfId-7503260]You can use a device stack as you would a single device in your deployment, with a few exceptions. If you have clustered devices, you cannot stack a device cluster or a device in a clustered pair. See Clustering Devices for more information. You also cannot configure NAT on a device stack.
 
     
      
    
 
    
 
    [bookmark: pgfId-7538316]Note If you use eStreamer to stre[bookmark: marker-7538315]am event data from stacked devices to an external client application, collect the data from each device and ensure that you configure each device identically. The eStreamer settings are not automatically synchronized between stacked devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7471410]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7471414]Establishing Device Stacks
 
     	 [bookmark: pgfId-7499836]Editing Device Stacks
 
     	 [bookmark: pgfId-7516467]Configuring Individual Devices in a Stack
 
     	 [bookmark: pgfId-7471418]Separating Stacked Devices
 
     	 [bookmark: pgfId-8250905]Replacing a Device in a Stack
 
    
 
     
      [bookmark: pgfId-7471420][bookmark: 28149]Establis[bookmark: marker-7535569]hing Device Stacks
 
     [bookmark: pgfId-7741992]License: Any
 
     [bookmark: pgfId-7741993]Supported Devices: 3D8140, 3D8200 family, 3D8300 family, AMP8300 family, 3D9900
 
     [bookmark: pgfId-7741994]You can increase the amount of traffic inspected on a network segment by stacking two fiber-based 3D9900s, two 3D8140 devices, up to four 3D8250s, a 3D8260, a 3D8270, a 3D8290, up to four 3D8350s, a 3D8360, a 3D8370, or a 3D8390, up to four AMP8350s, an AMP8360, and AMP8370, or an AMP8390 and using their combined resources in a single, shared, configuration. Before you begin, you must:
 
      
      	 [bookmark: pgfId-7471447]decide which unit will be the primary device
 
      	 [bookmark: pgfId-7471448]cable the units properly before designating the primary/secondary relationship. For information ab[bookmark: marker-7471449]out cabling, see the  FireSIGHT System Installation Guide .
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7502915]Note If you have clustered devices, you cannot stack a device cluster or a device in a clustered pair. However, you can cluster a device stack. See Clustering Devices for more information.
 
      
      
 
     
 
     
 ) in the appliance list. 
     
 
     [bookmark: pgfId-7502990]Removing registration of a device stack from a Defense Center also removes registration from both devices. You delete stacked devices from the Defense Center as you would a single managed device; you can then register the stack on another Defense Center. You only need to register one of the stacked devices on the new Defense Center for the entire stack to appear. See Deleting Devices and Adding Devices to the Defense Center for more information.
 
     [bookmark: pgfId-7742017]After you establish the device stack, you cannot change which devices are primary or secondary unless you break and reestablish the stack. However, you can:
 
      
      	 [bookmark: pgfId-7742026]add secondary devices to an existing stack of two or three 3D8250s, a 3D8260, or a 3D8270 up to the limit of four 3D8250s in a stack
 
      	 [bookmark: pgfId-7742041]add secondary devices to an existing stack of two or three 3D8350s, a 3D8360, or a 3D8370 up to the limit of four 3D8350s in a stack
 
      	 [bookmark: pgfId-8213302]add secondary devices to an existing stack of two or three AMP8350s, an AMP8360, or an AMP8370 up to the limit of four AMP8350s in a stack
 
     
 
     [bookmark: pgfId-7742047]For additional devices, the primary device in the stack must have the necessary stacking NetMods for additional cabled devices. For example, if you have a 3D8260 where the primary only has a single stacking NetMod, you cannot add another secondary device to this stack. You add secondary devices to an existing stack in the same manner that you initially establish a stacked device configuration.
 
     [bookmark: pgfId-7471461]To establish a stacked device configuration:
 
     [bookmark: pgfId-7471462]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7471466]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7471467]The Device Management page appears.
 
     [bookmark: pgfId-7474011]Step 2 From the Add drop-down menu, select Add Stack.
 
     [bookmark: pgfId-7474070]The Add Stack pop-up window appears.
 
     [bookmark: pgfId-7474233]Step 3 From the Primary drop-down list, select the device that you cabled for primary operation.
 
      
       
     
 
     
 
     [bookmark: pgfId-7471469]Note If you edit a device that is not cabled as the primary device, you cannot perform the next series of steps.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7474654]Step 4 In the Name field, type the name of the stack. You may enter alphanumeric characters and special characters, with the exception of the following characters, which are invalid: +, (, ), {, }, #, &, \, <, >, ?, ‘, and “.
 
     [bookmark: pgfId-7474689]Step 5 [bookmark: 91382]Click Add to select the devices you want to form a stack with.
 
     [bookmark: pgfId-7474757]The Add Secondary Connection pop-up window appears. The following graphic displays the primary device front view for a 3D8140.
 
     [bookmark: pgfId-7489443]Step 6 From the Slot on Primary Device drop-down list, select the stacking network module that connects the primary device to the secondary device.
 
     [bookmark: pgfId-7538867]Step 7 From the Secondary Device drop-down list, select the device you cabled for secondary operation.
 
      
       
     
 
     
 
     [bookmark: pgfId-7741989]Note All devices in a stack must be of the same hardware model (for example, 3D9900 with 3D9900, 3D8140 with 3D8140, and so on). You can stack a total of four devices (one primary device and up to three secondary devices) in the 82xx Family and in the 83xx Family.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7489490]Step 8 From the Slot on Secondary Device drop-down list, select the stacking network module that connects the secondary device to the primary device.
 
     [bookmark: pgfId-7489905]Step 9 [bookmark: 32128]Click Add.
 
     [bookmark: pgfId-7490344]The Add Stack window reappears with the new secondary device included.
 
     [bookmark: pgfId-7490348]Step 10 Optionally, repeat steps 5 through 9 if you are adding secondary devices to an existing stack of 3D8250s, a 3D8260, a 3D8270, an existing stack of 3D8350s, a 3D8360, or a 3D8370, or an existing stack of AMP8350s, an AMP8360, or an AMP8370.
 
     [bookmark: pgfId-7490349]Step 11 Click Stack.
 
     [bookmark: pgfId-7499865]The device stack is established or the additional secondary devices are added. Note that this process takes a few minutes as the process synchronizes system data.
 
     [bookmark: pgfId-7877125]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7499875][bookmark: 87024]Editing Devi[bookmark: marker-7535597]ce Stacks
 
     [bookmark: pgfId-7499919]License: Any
 
     [bookmark: pgfId-7620185]Supported Devices: 3D8140, 3D8200 family, 3D8300 family, AMP8300 family, 3D9900
 
     [bookmark: pgfId-7513738]After you establish a device stack, most changes you make to the device configuration also change the configuration of the entire stack. On the Stack page of the appliance editor, you can make changes to the stack configuration as on the Device page of a single device.
 
     [bookmark: pgfId-7514667]You can change the display name of the stack, enable and disable licenses, view system and health policies, configure automatic application bypass, and set up fast-path rules.
 
     [bookmark: pgfId-7514689]See the following sections for more information:
 
      
      	 [bookmark: pgfId-8093408]Editing General Device Settings
 
      	 [bookmark: pgfId-7515723]Enabling and Disabling Device Licenses
 
      	 [bookmark: pgfId-7515727]Editing Advanced Device Settings
 
     
 
     [bookmark: pgfId-7515728]To edit a stacked configuration:
 
     [bookmark: pgfId-7515818]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7514308]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7514330]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7514367]The Stack page for that device appears.
 
     [bookmark: pgfId-7539118]Step 3 Use the sections on the Stack page to make changes to the stacked configuration as you would a single device configuration.
 
     [bookmark: pgfId-7877238]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7539134][bookmark: 44475]Configuring Indiv[bookmark: marker-7539133]idual Devices in a Stack
 
     [bookmark: pgfId-8213826]License: Any
 
     [bookmark: pgfId-8213830]Supported Devices: 3D8140, 3D8200 family, 3D8300 family, AMP8300 family, 3D9900
 
     [bookmark: pgfId-8213831]After you establish a device stack, you can still configure some attributes for only one device within the stack. On the Devices page of the appliance editor, you can make changes to a device configured in a stack as on the Device page of a single device. 
 
     [bookmark: pgfId-7515779]You can change the display name of a device, view system settings, shut down or restart a device, view health information, and edit device management settings.
 
     [bookmark: pgfId-7515787]See the following sections for more information:
 
      
      	 [bookmark: pgfId-8093496]Editing General Device Settings
 
      	 [bookmark: pgfId-7515795]Editing Device System Settings
 
      	 [bookmark: pgfId-7530431]Viewing the Health of a Device
 
      	 [bookmark: pgfId-8189038]Editing Device Management Settings
 
     
 
     [bookmark: pgfId-8189039]To configure an individual device in a stack:
 
     [bookmark: pgfId-8189043]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7515870]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7515909]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7516087]The Stack page for that device appears.
 
     [bookmark: pgfId-7516118]Step 3 Click Devices.
 
     [bookmark: pgfId-7516226]The Devices page appears.
 
     [bookmark: pgfId-7516315]Step 4 From the Selected Device drop-down list, select the device you want to modify.
 
     [bookmark: pgfId-7539274]Step 5 Use the sections on the Devices page to make changes to the individual stacked device as you would a single device.
 
     [bookmark: pgfId-7877250]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7516476]Config[bookmark: marker-7535621]uring Inter[bookmark: marker-7535613]faces on a Stacked Device
 
     [bookmark: pgfId-7615388]License: Any
 
     [bookmark: pgfId-7620062]Supported Devices: 3D8140, 3D8200 family, 3D8300 family, AMP8300 family, 3D9900
 
     [bookmark: pgfId-7615390]Except for the management interface, you configure stacked device interfaces on the Interfaces page of the primary device in the stack. You can select any device in the stack to configure the management interface. See Configuring Management Interfaces for more information.
 
     [bookmark: pgfId-7926626]The Interfaces page of a Series 3 stacked device includes the hardware and interfaces views that you find on an individual device. The interfaces page of a 3D9900 does not include these views. See Configuring Sensing Interfaces for more information.
 
     [bookmark: pgfId-7926630]To configure interfaces on a stacked device:
 
     [bookmark: pgfId-7517577]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7517578]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7517579]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7517680]The Stack page for that device appears.
 
     [bookmark: pgfId-7517681]Step 3 Click Interfaces.
 
     [bookmark: pgfId-7517682]The Interfaces page appears.
 
     [bookmark: pgfId-7517683]Step 4 From the Selected Device drop-down list, select the device you want to modify.
 
     [bookmark: pgfId-7517684]Step 5 Configure interfaces as you would on an individual device. See Configuring Sensing Interfaces for more information.
 
     [bookmark: pgfId-7877297]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7517386][bookmark: 42859]Separat[bookmark: marker-7535627]ing Stacked Devices
 
     [bookmark: pgfId-7514803]License: Any
 
     [bookmark: pgfId-7620090]Supported Devices: 3D8140, 3D8200 family, 3D8300 family, AMP8300 family, 3D9900
 
     [bookmark: pgfId-7481143]If you no longer need to use a stacked configuration for your devices, you can break the stack and separate the devices.
 
     [bookmark: pgfId-7481145]To separate stacked devices:
 
     [bookmark: pgfId-7480868]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7481167]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7480870]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7502119]The Confirm Break pop-up window appears.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7502175]Step 3 Click Yes.
 
    [bookmark: pgfId-7534011]The device stack is separated.
 
    [bookmark: pgfId-8089333]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8241149][bookmark: 63287]Replacing a Device in a Stack
 
    [bookmark: pgfId-8241153]License: Any
 
    [bookmark: pgfId-8242057]Supported Devices: 3D8140, 3D8200 family, 3D8300 family, AMP8300 family, 3D9900
 
    [bookmark: pgfId-8242058]To replace a stacked device, you must break the stack.
 
     
      
    
 
    
 
    [bookmark: pgfId-8242158]Warning If the Defense Center cannot communicate with the device, you must connect to the device and use CLI commands to separate the stack and unregister the device from the Defense Center. For more information, see stacking disable and delete CLI commands in Configuration Commands.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8242059]To replace a device in a device stack:
 
    
 
    [bookmark: pgfId-8241160]Step 1 Select the stack with the device to replace and break that stack. For more information, see Separating Stacked Devices.
 
    [bookmark: pgfId-8241169]Step 2 Unregister the device from the Defense Center. For more information, see Disabling High Availability and Unregistering Devices.
 
    [bookmark: pgfId-8241180]Step 3 Register the replacement device to the Defense Center. For more information, see Adding Devices to the Defense Center.
 
    [bookmark: pgfId-8241184]Step 4 Create a device stack that includes the replacement device. For more information, see Establishing Device Stacks.
 
   
 
    
     [bookmark: pgfId-8089337][bookmark: 64195]Editing Device Conf[bookmark: marker-8089336]iguration
 
    [bookmark: pgfId-7534017]License: Any
 
    [bookmark: pgfId-7261200]The Device page of the appliance editor displays detailed device configuration and information. It also allows you to make changes to some parts of device configuration, such as enabling and disabling licenses, shutting down and restarting a device, modifying management, and setting up fast-path rules.
 
    [bookmark: pgfId-7220673]See the following sections for more information:
 
     
     	 [bookmark: pgfId-8093568]Editing General Device Settings
 
     	 [bookmark: pgfId-7610666]Enabling and Disabling Device Licenses
 
     	 [bookmark: pgfId-7223524]Editing Device System Settings
 
     	 [bookmark: pgfId-7223546]Viewing the Health of a Device
 
     	 [bookmark: pgfId-7223584]Editing Device Management Settings
 
     	 [bookmark: pgfId-8090809]Understanding Advanced Device Settings
 
    
 
     
      [bookmark: pgfId-7877377][bookmark: 85748]Editing General Device Settings
 
     [bookmark: pgfId-8089260]License: Any
 
     [bookmark: pgfId-8108942]The General section of the Device tab displays the managed device settings listed below, which you can change.
 
     [bookmark: pgfId-8089457]Name
 
     [bookmark: pgfId-8089535]The assigned name for the managed device.
 
     [bookmark: pgfId-8089614]Transfer Packets
 
     [bookmark: pgfId-8089661]Indicates whether packet data is transferred to the Defense Center to be stored with events. 
 
     [bookmark: pgfId-8089883]To edit the general device settings:
 
     [bookmark: pgfId-8089887]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-8089888]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-8089889]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-8089894]The Interfaces page for that device appears.
 
     [bookmark: pgfId-8089895]Step 3 Click Device.
 
     [bookmark: pgfId-8089896]The Device page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8089897]Tip For stacked devices, you edit the assigned device name for the stack on the Stack page of the appliance editor. You can edit the assigned device name for an individual device on the Devices page of the appliance editor.
 
      
      
 
     
 
     
 ). 
     
 
     [bookmark: pgfId-8089902]The General pop-up window appears.
 
     [bookmark: pgfId-8089903]Step 5 In the Name field, type a new assigned name for the device. You may enter alphanumeric characters and special characters, with the exception of the following characters, which are invalid: +, (, ), {, }, #, &, \, <, >, ?, ‘, and “.
 
     [bookmark: pgfId-8090023]Step 6 Select the Transfer Packets check box to allow packet data to be stored with events on the Defense Center. Clear the check box to prevent the managed device from sending packet data with the events.
 
     [bookmark: pgfId-8090300]Step 7 Click Save.
 
     [bookmark: pgfId-8090316]The changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    
 
     
      [bookmark: pgfId-7224361][bookmark: 70415]Enabling and Disabling Device Licenses
 
     [bookmark: pgfId-7175841]License: Any
 
     [bookmark: pgfId-7610984]Supported Devices: Series 3, Virtual, X-Series, ASA FirePOWER
 
     [bookmark: pgfId-7728486]You can enable licenses on your device if you have available licenses on your Defense Center. Note that:
 
      
      	 [bookmark: pgfId-7581187]Control, Malware, and URL Filtering licenses require a Protection license. 
 
      	 [bookmark: pgfId-8178160]You cannot enable a VPN license on a virtual device, Cisco NGIPS for Blue Coat X-Series, or ASA FirePOWER devices.
 
      	 [bookmark: pgfId-8178170]Although you can enable a Control license on a virtual device, Cisco NGIPS for Blue Coat X-Series, or ASA FirePOWER device, these devices do  not support fast-path rules, switching, routing, stacking, or clustering. Cisco NGIPS for Blue Coat X-Series also does not support application or user control.
 
      	 [bookmark: pgfId-7619463]You cannot change the license settings on clustered devices.
 
      	 [bookmark: pgfId-7619475]Because Series 2 devices automatically have Protection capabilities, with the exception of Security Intelligence filtering, you cannot disable these capabilities, nor can you apply other licenses to a Series 2 device.
 
     
 
     [bookmark: pgfId-7619467]For more information, see Licensing the FireSIGHT System.
 
     [bookmark: pgfId-7611174]To enable or disable device licenses:
 
     [bookmark: pgfId-7611175]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7230508]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7230509]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7230514]The Interfaces tab for that device appears.
 
     [bookmark: pgfId-7230515]Step 3 Click Device.
 
     [bookmark: pgfId-7230516]The Devices tab appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-7542361]Tip For stacked devices, you enable or disable the licenses for the stack on the Stack page of the appliance editor.
 
      
      
 
     
 
     
 ). 
     
 
     [bookmark: pgfId-7230518]The License pop-up window appears.
 
     [bookmark: pgfId-7230519]Step 5 You have the following options:
 
      
       
       	 [bookmark: pgfId-7314861]To enable a license, select the check box next to the license name.
 
       	 [bookmark: pgfId-7314866]To disable a license, clear the check box next to the license name.
 
      
 
     
 
     [bookmark: pgfId-7230520]Step 6 Click Save.
 
     [bookmark: pgfId-7230521]The changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
     [bookmark: pgfId-7877411]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7222398][bookmark: 97879]Editing Device System Settings
 
     [bookmark: pgfId-7222399]License: Any
 
     [bookmark: pgfId-7837723]The System section of the Device tab displays a read-only table of system information, as described in the following table.
 
     [bookmark: pgfId-7789672]
 
      
       
        
        [bookmark: pgfId-7789645]Table 4-2 System Section Table Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-7789649]Field 
          
  
         	 
           
           [bookmark: pgfId-7789651]Description 
          
  
        
 
         
         	[bookmark: pgfId-7789653]Model
  
         	[bookmark: pgfId-7789655]The model name and number for the managed device.
  
        
 
         
         	[bookmark: pgfId-7789657]Serial
  
         	[bookmark: pgfId-7789659]The serial number of the chassis of the managed device.
  
        
 
         
         	[bookmark: pgfId-7789661]Time
  
         	[bookmark: pgfId-7789663]The current system time of the device.
  
        
 
         
         	[bookmark: pgfId-7789665]Version
  
         	[bookmark: pgfId-7789667]The version of the software currently installed on the managed device.
  
        
 
         
         	[bookmark: pgfId-7789669]Policy
  
         	[bookmark: pgfId-7789671]A link to the system policy currently applied to the managed device.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7789559]You can also shut down or restart the device.
 
      
       
     
 
     
 
     [bookmark: pgfId-7849408]Note Y[bookmark: marker-7804917]ou canno[bookmark: marker-7805788]t shut down or restart X-Series or ASA FirePOWER devices with the FireSIGHT System user interface. See the Cisco NGIPS for Blue Coat X-Series Installation Guide or the ASA documentation for more information on how to shut down the respective devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7789564]To shut down and restart a managed device:
 
     [bookmark: pgfId-7789565]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7230969]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7230970]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7230975]The Interfaces tab for that device appears.
 
     [bookmark: pgfId-7230976]Step 3 Click Device.
 
     [bookmark: pgfId-7230977]The Devices tab appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-7542504]Tip For stacked devices, you shut down or restart an individual device on the Devices page of the appliance editor.
 
      
      
 
     
 
     
 ). 
     
 
     [bookmark: pgfId-7231344]Step 5 When prompted, confirm that you want to shut down the device.
 
     [bookmark: pgfId-7231564]You are returned to the Device Management page.
 ). 
     
 
     [bookmark: pgfId-7231766]Step 7 When prompted, confirm that you want to restart the device. 
 
     [bookmark: pgfId-7497218]The device is restarted.
 
     [bookmark: pgfId-7310415]Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
     [bookmark: pgfId-7877457]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7222512][bookmark: 73167]Viewing the Health of a Device
 
     [bookmark: pgfId-7222513]License: Any
 
     [bookmark: pgfId-7222514]The Health section of the Device tab displays health-related information. You can view an icon showing the current health status of the managed device. You can also click the icon to navigate to the Health Monitor page for that device. See Interpreting Health Monitor Status for more information.
 
     [bookmark: pgfId-7420224]You can click the Policy link to view a read-only version of the currently applied health policy. See Editing Health Policies for more information.
 
     [bookmark: pgfId-7420235]You can also click the Blacklist link to go to the Health Blacklist page, where you can enable and disable health blacklist modules. See Blacklisting a Health Policy Module for more information.
 
    
 
     
      [bookmark: pgfId-7225170][bookmark: 10420]Editing Device Management Settings
 
     [bookmark: pgfId-7561888]License: Any
 
     [bookmark: pgfId-8130889]The Management section of the Device tab displays the remote management information listed below. 
 
     [bookmark: pgfId-8091269]Host
 
     [bookmark: pgfId-8123709]The current management host name or IP address of the device. You can use this setting to specify the management host name and regenerate the virtual IP address.
 
      
       
     
 
     
 
     [bookmark: pgfId-8160384]Note In some cases, if you edit the host name or IP address of a device by another method (using the device’s LCD panel or CLI, for example), you may need to use the procedure below to manually update the host name or IP address on the managing Defense Center. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8123710]Status
 
     [bookmark: pgfId-8091544]Specifies the status of the communication channel between the Defense Center and the managed device.
 
      
       
     
 
     
 
     [bookmark: pgfId-8124438]Tip You can click the slider to enable or disable management of the managed device. Disabling management blocks the connection between the Defense Center and the device, but does not delete the device from the Defense Center. If you no longer want to manage a device, see Deleting Devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8124439]To modify device management options:
 
     [bookmark: pgfId-8092315]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-8092316]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-8092317]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-8092322]The Interfaces tab for that device appears.
 
     [bookmark: pgfId-8092323]Step 3 Click Device.
 
     [bookmark: pgfId-8092324]The Devices tab appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8092325]Tip For stacked devices, you modify management options on an individual device on the Devices page of the appliance editor.
 
      
      
 
     
 
     
 ). 
     
 
     [bookmark: pgfId-8092330]The Management pop-up window appears.
 
     [bookmark: pgfId-8092331]Step 5 In the Host field, enter the name or IP address of the management host.
 
     [bookmark: pgfId-8092337]Step 6 Click Save.
 
     [bookmark: pgfId-8092338]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
     [bookmark: pgfId-8092342]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7223869][bookmark: 12945]Understanding Advanced Device Settings
 
     [bookmark: pgfId-7226869]License: Any
 
     [bookmark: pgfId-7627553]Supported Devices: feature dependent
 
      
       
        
        [bookmark: pgfId-7627459]Table 4-3 Advanced Section Table Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-7627465]Field 
          
  
         	 
           
           [bookmark: pgfId-7627467]Description 
          
  
         	 
           
           [bookmark: pgfId-7627469]Supported Devices 
          
  
        
 
         
         	[bookmark: pgfId-7627471]Application Bypass
  
         	[bookmark: pgfId-7627473]The state of Automatic Application Bypass on the device.
  
         	[bookmark: pgfId-7791150]Series 2, Series 3, Virtual
  
        
 
         
         	[bookmark: pgfId-7627477]Bypass Threshold
  
         	[bookmark: pgfId-7627479]The Automatic Application Bypass threshold, in milliseconds.
  
         	[bookmark: pgfId-7627481]Series 2, Series 3, Virtual
  
        
 
         
         	[bookmark: pgfId-7627483]Inspect Local Router Traffic
  
         	[bookmark: pgfId-7627485]Whether the device inspects traffic received on routed interfaces that is destined for itself, such as ICMP, DHCP, and OSPF traffic.
  
         	[bookmark: pgfId-7627487]Series 3
  
        
 
         
         	[bookmark: pgfId-7627489]Fast-Path Rules
  
         	[bookmark: pgfId-7627491]The number of fast-path rules that have been created on the device.
  
         	[bookmark: pgfId-7627493]8000 Series, 3D9900
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7226901]You can use the Advanced section to edit any of these settings. See the following sections for more information:
 
      
      	 [bookmark: pgfId-7223900]Automatic Application Bypass
 
      	 [bookmark: pgfId-7237537]Editing Advanced Device Settings
 
      	 [bookmark: pgfId-7237548]Configuring Fast-Path Rules
 
     
 
    
 
     
      [bookmark: pgfId-7627586][bookmark: 74071]Automatic Appli[bookmark: marker-7627585]cation Bypass
 
     [bookmark: pgfId-7627587]License: Any
 
     [bookmark: pgfId-7837780]The Automatic Application Bypass (AAB) feature limits the time allowed to process packets through an interface and allows packets to bypass detection if the time is exceeded. The feature functions with any deployment; however, it is most valuable in inline deployments.
 
     [bookmark: pgfId-7237620]You balance packet processing delays with your network’s tolerance for packet latency. When a malfunction within Snort or a device misconfiguration causes traffic processing time to exceed a specified threshold, AAB causes Snort to restart within ten minutes of the failure, and generates troubleshoot data that can be analyzed to investigate the cause of the excessive processing time.
 
     [bookmark: pgfId-7797974]In Version 5.4.1 and higher, the default behavior for the AAB option varies by device, as follows:
 
      
      	 [bookmark: pgfId-7800180]Series 3: off
 
      	 [bookmark: pgfId-7800251]Series 2 and virtual: on
 
      	 [bookmark: pgfId-7840195]ASA FirePOWER: not supported
 
      	 [bookmark: pgfId-7800261]X-Series: not supported
 
     
 
     [bookmark: pgfId-7799331]If you upgrade from a version earlier than 5.3, the existing setting is retained. You can change the bypass threshold if the option is selected. The default setting is 3000 milliseconds (ms). The valid range is from 250 ms to 60,000 ms.
 
     [bookmark: pgfId-7797975]Typically, you use Rule Latency Thresholding in the intrusion policy to fast-path packets after the latency threshold value is exceeded. Rule Latency Thresholding does not shut down the engine or generate troubleshoot data. For more information, see Configuring Packet and Intrusion Rule Latency Thresholds.
 
      
       
     
 
     
 
     [bookmark: pgfId-7237629]Note AAB is activated only when an excessive amount of time is spent processing a single packet. If AAB engages the Snort process restarts. which temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See How Snort Restarts Affect Traffic for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7236501]If detection is bypassed, the device generates a health monitoring alert. For more information on that health monitoring alert, see Using the Health Monitor.
 
     [bookmark: pgfId-8013797]For more information about enabling Automatic Application Bypass and setting the bypass threshold, see Editing Advanced Device Settings.
 
    
 
     
      [bookmark: pgfId-8013803][bookmark: 59249]Editing Advanced Device Settings
 
     [bookmark: pgfId-7223903]License: Any
 
     [bookmark: pgfId-7646759]Supported Devices: feature dependent
 
     [bookmark: pgfId-7501340]You can use the Advanced section of the Devices tab to modify the Automatic Application Bypass and Inspect Local Router Traffic settings. You can also configure fast-path rules, as explained in Configuring Fast-Path Rules. 
 
     [bookmark: pgfId-7501347]Note the following:
 
      
      	 [bookmark: pgfId-7646810]you can configure fast-path rules only on 8000 Series and 3D9900 devices.
 
      	 [bookmark: pgfId-7646836]you can configure  Inspect Local Router Traffic only on Series 3 devices
 
     
 
     [bookmark: pgfId-7501348]To modify advanced device settings:
 
     [bookmark: pgfId-7236770]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7236771]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7236772]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7236803]The Interfaces tab for that device appears.
 
     [bookmark: pgfId-7236804]Step 3 Click Device.
 
     [bookmark: pgfId-7236805]The Devices tab appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-7542435]Tip For stacked devices, you edit the advanced device settings for the stack on the Stack page of the appliance editor.
 
      
      
 
     
 
     
 ). 
     
 
     [bookmark: pgfId-7236807]The Advanced pop-up window appears.
 
     [bookmark: pgfId-7237292]Step 5 Optionally, select Automatic Application Bypass if your network is sensitive to latency. Automatic Application Bypass is most useful in inline deployments. For more information, see Automatic Application Bypass.
 
     [bookmark: pgfId-7237293]Step 6 When you select the Automatic Application Bypass option, you can type a Bypass Threshold in milliseconds (ms). The default setting is 3000 ms and the valid range is from 250 ms to 60,000 ms.
 
     [bookmark: pgfId-7236909]Step 7 Optionally, select the Inspect Local Router Traffic check box to inspect exception traffic when deployed as a router.
 
     [bookmark: pgfId-7236810]Step 8 Optionally, configure fast-path rules. For more information, see Configuring Fast-Path Rules.
 
     [bookmark: pgfId-7236814]Step 9 Click Save.
 
     [bookmark: pgfId-7236815]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
     [bookmark: pgfId-7877512]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7176475][bookmark: 36518]Configu[bookmark: marker-7350902]ring Fast-Path Rules
 
     [bookmark: pgfId-7311135]License: Any
 
     [bookmark: pgfId-7479942]Supported Devices: 8000 Series, 3D9900
 
     [bookmark: pgfId-7311136]You can create fast-path rules to send traffic directly through a device with no further inspection. Fast-path rules divert traffic that does not need to be analyzed to bypass the device. Fast-path rules either send traffic to the fast-path (out of the interface) or allow it to continue into the device for further analysis. Their advantage is the speed at which they determine the correct path for the traffic. Because the fast-path rules function at the hardware level, they only determine limited information about the packet.
 
     [bookmark: pgfId-7250960]See the following sections for more information:
 
      
      	 [bookmark: pgfId-7251014]Adding IPv4 Fast-Path Rules
 
      	 [bookmark: pgfId-7251033]Adding IPv6 Fast-Path Rules
 
      	 [bookmark: pgfId-7252324]Deleting Fast-Path Rules
 
     
 
    
 
     
      [bookmark: pgfId-7250694][bookmark: 30566]Adding IPv4 Fast-P[bookmark: marker-7350930]ath Rules
 
     [bookmark: pgfId-7250702]License: Any
 
     [bookmark: pgfId-7684453]Supported Devices: 8000 Series, 3D9900
 
     [bookmark: pgfId-7250703]Fast-path rules send traffic to the fast-path (out of the interface) or into the device for further analysis. You can use the following criteria to select the IPv4 traffic you want to divert to the fast-path and not inspect:
 
      
      	 [bookmark: pgfId-7250707]initiator or responder IP address or CIDR block
 
      	 [bookmark: pgfId-7250708]protocol
 
      	 [bookmark: pgfId-7250709]initiator or responder port, for TCP or UDP protocols
 
      	 [bookmark: pgfId-7250710]VLAN ID
 
      	 [bookmark: pgfId-7250711]bidirectional option
 
     
 
     [bookmark: pgfId-7316083]Note that the outermost ID is used for fast-path rules.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7316088]To build or edit IPv4 fast-path rules:
 
    [bookmark: pgfId-7250717]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7251123]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7251124]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7251129]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7251130]Step 3 Click Device.
 
    [bookmark: pgfId-7251131]The Devices tab appears.
 ). 
    
 
    [bookmark: pgfId-7410219]The Advanced pop-up window appears.
 
    [bookmark: pgfId-7410221]Step 5 Click New IPv4 Rule to add a fast-path rule.
 
    [bookmark: pgfId-7250732]The New IPv4 Rule pop-up window appears.
 
    [bookmark: pgfId-7251372]Step 6 From the Domain drop-down list, select an inline set or passive security zone. See Setting Up an IPS Device for more information.
 
    [bookmark: pgfId-7251379]Step 7 Use CIDR notation in the Initiator and the Responder fields to designate the IP addresses of initiators or responders whose packets should bypass further analysis.
 
    [bookmark: pgfId-7250745]Your rule matches packets from the designated initiators or packets to the designated responders. For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
    [bookmark: pgfId-7251652]Step 8 [bookmark: 41623]Optionally, from the Protocol drop-down list, select the protocol on which you want the rule to act or select All to match traffic from any protocol on the list.
 
    [bookmark: pgfId-7251763]Step 9 Optionally, if you chose the TCP or UDP protocol in step 8, enter initiator and responder ports in the Initiator Port and the Responder Port fields to designate ports.
 
     
      
    
 
    
 
    [bookmark: pgfId-7250764]Tip You can enter a comma-separated list of port numbers in each rule. You cannot use port ranges in IPv4 fast-path rules. Note that a blank port value is treated as Any.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7250765]If you also select the Bidirectional option, your filter criteria are narrowed to packets from those initiator ports or packets to those responder ports.
 
    [bookmark: pgfId-7251793]Step 10 Optionally, enter a VLAN ID in the VLAN field.
 
    [bookmark: pgfId-7250767]Your rule matches only traffic for that VLAN. Note that a blank VLAN value is treated as Any.
 
    [bookmark: pgfId-7251798]Step 11 Optionally, select the Bidirectional option to filter all traffic traveling between the specified initiator and responder IP addresses. Clear the option to filter only traffic from the specified initiator IP address to the specified responder IP address.
 
    [bookmark: pgfId-7251627]Step 12 Click Save. 
 
    [bookmark: pgfId-7251899]The rule is added under Fast-Path Rules in the Advanced pop-up window. Although the rule is added, you must click Save again to save the rule. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7877540]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7250790][bookmark: 27646]Adding IPv6 Fast-Pa[bookmark: marker-7350914]th Rules
 
    [bookmark: pgfId-7250798]License: Any
 
    [bookmark: pgfId-7480034]Supported Devices: Series 3, 3D9900
 
    [bookmark: pgfId-7250800]Fast-path rules send traffic to the fast-path (out of the interface) or into the device for further analysis. You can use the following criteria to select the IPv6 traffic you want to divert to the fast-path and not inspect:
 
     
     	 [bookmark: pgfId-7794300]initiator or responder IP address or address block
 
     	 [bookmark: pgfId-7250804]protocol
 
     	 [bookmark: pgfId-7250805]initiator or responder port, for TCP or UDP protocols
 
     	 [bookmark: pgfId-7250806]VLAN ID
 
     	 [bookmark: pgfId-7250807]bidirectional option
 
    
 
    [bookmark: pgfId-7250808]Note that the outermost VLAN ID is used for fast-path rules.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7250812]To add an IPv6 fast-path rule:
 
   [bookmark: pgfId-7252232]Access: Admin/Network Admin
 
   
 
   [bookmark: pgfId-7252233]Step 1 Select Devices > Device Management.
 
   [bookmark: pgfId-7252234]The Device Management page appears.
 ). 
   
 
   [bookmark: pgfId-7252239]The Interfaces tab for that device appears.
 
   [bookmark: pgfId-7252240]Step 3 Click Device.
 
   [bookmark: pgfId-7252241]The Devices tab appears.
 
   [bookmark: pgfId-7252242]Step 4 Next to the Advanced section, click the edit icon.
 
   [bookmark: pgfId-7252243]The Advanced pop-up window appears.
 
   [bookmark: pgfId-7252244]Step 5 Click New IPv6 Rule to add a fast-path rule.
 
   [bookmark: pgfId-7410387]The New IPv6 Rule pop-up window appears. Note that the initiator and responder fields are fixed and indicate that the filter applies to IPv6 packets from any initiator or responder.
 
   [bookmark: pgfId-7410391]Step 6 From the Domain drop-down list, select an inline set or passive security zone. See Setting Up an IPS Device for more information.
 
   [bookmark: pgfId-7794061]Step 7 [bookmark: 80910]Type IP addresses or use IPv6 prefix length notation to specify address blocks in the Initiator and the Responder fields for the IP addresses of initiators or responders whose packets should bypass further analysis.
 
   [bookmark: pgfId-7794062]Your rule matches packets from the designated initiators or packets to the designated responders. For information on using IPv6 prefix length notation in the FireSIGHT System, see IP Address Conventions.
 
   [bookmark: pgfId-7252682]Step 8 Optionally, from the Protocol drop-down list, select the protocol on which you want the rule to act or select All to match traffic from any protocol on the list.
 
   [bookmark: pgfId-7252609]Your fast-path rule matches only the selected protocol’s packets.
 
   [bookmark: pgfId-7252927]Step 9 Optionally, if you chose the TCP or UDP protocol in step 7, enter initiator and responder ports in the Initiator Port and the Responder Port fields to designate ports.
 
    
     
   
 
   
 
   [bookmark: pgfId-7252614]Tip You can enter a comma-separated list of port numbers in each rule. You cannot use port ranges in IPv6 fast-path rules. Note that a blank port value is treated as Any.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-7252695]Step 10 Optionally, enter a VLAN ID in the VLAN field.
 
   [bookmark: pgfId-7252661]Your rule matches only traffic for that VLAN. Note that a blank VLAN value is treated as Any.
 
   [bookmark: pgfId-7252642]Step 11 Optionally, select Bidirectional to filter all traffic traveling between the specified initiator and responder ports. Clear the option to specify that your rule matches only packets from those initiator ports or packets to those responder ports.
 
   [bookmark: pgfId-7252789]Step 12 Click Save. 
 
   [bookmark: pgfId-7252790]The rule is added under Fast-Path Rules in the Advanced pop-up window.
 
   [bookmark: pgfId-7252791]Step 13 In the Advanced pop-up window, click Save.
 
   [bookmark: pgfId-7252792]The rule is saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
   [bookmark: pgfId-7877597]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7176901][bookmark: 18923]Deleting Fa[bookmark: marker-7350948]st-Path Rules
 
    [bookmark: pgfId-7615810]License: Any
 
    [bookmark: pgfId-7620345]Supported Devices: 8000 Series, 3D9900
 
    [bookmark: pgfId-7615815]The following procedure explains how to delete any IPv4 or IPv6 fast-path rule.
 
    [bookmark: pgfId-7177108]To delete any fast-path rule:
 
    [bookmark: pgfId-7177109]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7252750]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7252751]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7252756]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7252757]Step 3 Click Device.
 
    [bookmark: pgfId-7252758]The Devices tab appears.
 ). 
    
 
    [bookmark: pgfId-7252760]The Advanced pop-up window appears.
 ). 
    
 
    [bookmark: pgfId-7253169]Step 6 When prompted, confirm that you want to delete the rule.
 
    [bookmark: pgfId-7253159]The rule is removed from the Advanced pop-up window.
 
    [bookmark: pgfId-7253278]Step 7 Click Save. 
 
    [bookmark: pgfId-7253312]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7877620]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7259513][bookmark: 89429]Configuring Sensing Inte[bookmark: marker-7371982]rfaces
 
    [bookmark: pgfId-7259514]License: Any
 
    [bookmark: pgfId-7837839]You can configure the sensing interfaces of a managed device, according to your FireSIGHT System deployment, from the Interfaces page of the appliance editor.
 
    [bookmark: pgfId-7476088]
 
     
      
       
       [bookmark: pgfId-7477141]Table 4-4 Using the Hardware View 
 
       
       
        
        	 
          
          [bookmark: pgfId-7477145]To... 
         
  
        	 
          
          [bookmark: pgfId-7477147]You can... 
         
  
       
 
        
        	[bookmark: pgfId-7477149]view a network module’s type, part number, and serial number
  
        	[bookmark: pgfId-7477151]hover your cursor over the dark circle in the lower left corner of the network module.
  
       
 
        
        	[bookmark: pgfId-7477153]select an interface in the interfaces table view
  
        	[bookmark: pgfId-7477155]click the interface.
  
       
 
        
        	[bookmark: pgfId-7477157]open an interface editor
  
        	[bookmark: pgfId-7477159]double-click the interface.
  
       
 
        
        	[bookmark: pgfId-7477161]view the name of the interface, the type of interface, whether the interface has link, the interface’s speed setting, and whether the interface is currently in bypass mode
  
        	[bookmark: pgfId-7477163]hover your cursor over the interface.
  
       
 
        
        	[bookmark: pgfId-7694971]view the details about an error or warning
  
        	[bookmark: pgfId-7694973]hover your cursor over the affected port on the network module.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8180800]The interfaces table view, which is below the Series 3 hardware view, lists all the available interfaces you have on a device. The table includes an expandable navigation tree you can use to view all configured interfaces. You can click the arrow icon next to an interface to collapse or expand the interface to hide or view its subcomponents. The interfaces table view also provides summarized information about each interface, as described in the following table. Note that only 8000 Series devices display the MAC Address and IP Address columns. See the following table for more information.
 
    [bookmark: pgfId-8180887]
 
     
     
 
      
       
       [bookmark: pgfId-8180809]Table 4-5 Interfaces Table View Fields 
 
       
       
        
        	 
          
          [bookmark: pgfId-8180813]Field 
         
  
        	 
          
          [bookmark: pgfId-8180815]Description 
         
  
       
 
        
        	[bookmark: pgfId-8180817]Name
  
        	[bookmark: pgfId-8180819]Each interface type is represented by a unique icon that indicates its type and link state (if applicable). You can hover your pointer over the name or the icon to view the interface type, speed, and duplex mode (if applicable) in a tooltip. The interface icons are described in Table 4-6.
 [bookmark: pgfId-8180823]The icons use a badging convention to indicate the current link state of the interface, which may be one of three states:
 
          
          	 [bookmark: pgfId-8180827]error (
 
          [image: ] ) 
         
 
          
          	 [bookmark: pgfId-8180831]fault (
 
          [image: ] ) 
         
 
          
          	 [bookmark: pgfId-8180835]not available (
 
          [image: ] ) 
         
 [bookmark: pgfId-8180838]Logical interfaces have the same link state as their parent physical interface. Cisco NGIPS for Blue Coat X-Series and ASA FirePOWER devices do not display link state. Note that disabled interfaces are represented by semi-transparent icons.
 [bookmark: pgfId-8180843]Interface names, which appear to the right of the icons, are auto-generated with the exception of hybrid and ASA FirePOWER interfaces, which are user-defined. Note that for ASA FirePOWER interfaces, the system displays only interfaces that are enabled, named, and have link.
 [bookmark: pgfId-8180850]Physical interfaces display the name of the physical interface. Logical interfaces display the name of the physical interface and the assigned VLAN tag.
 [bookmark: pgfId-8180854]ASA FirePOWER interfaces display the name of the security context and the name of the interface if there are multiple security contexts. If there is only one security context, the system displays only the name of the interface.
  
       
 
        
        	[bookmark: pgfId-8180856]Security Zone
  ). 
       
 
        
        	[bookmark: pgfId-8180863]Used by
  
        	[bookmark: pgfId-8180865]The inline set, virtual switch, or virtual router where the interface is assigned. ASA FirePOWER devices do not display the Used by column.
  
       
 
        
        	[bookmark: pgfId-8180870]MAC Address
  
        	[bookmark: pgfId-8180872]The MAC address displayed for the interface when it is enabled for switched and routed features.
 [bookmark: pgfId-8180873]For virtual devices, the MAC address is displayed so that you can match the network adapters configured on your device to the interfaces that appear on the Interfaces page. Cisco NGIPS for Blue Coat X-Series and ASA FirePOWER devices do not display MAC addresses.
  
       
 
        
        	[bookmark: pgfId-8180881]IP Addresses
  
        	 
          
          
 
          
 
          
 
          
 
          
 
          
 
          
 
          
 
          
 
          
 
          
 
           
            
            [bookmark: pgfId-8180894]Table 4-6 [bookmark: 11718]Interface Icon Types and Descriptions 
 
            
            
             
             	 
               
               [bookmark: pgfId-8180900]Icon 
              
  
             	 
               
               [bookmark: pgfId-8180902]Interface Type 
              
  
             	 
               
               [bookmark: pgfId-8180904]For more information, see... 
              
  
            
 
            
               
             	[bookmark: pgfId-8180911]Physical — an unconfigured physical interface.
  
             	[bookmark: pgfId-8180913]—
  
            
 
            
               
             	[bookmark: pgfId-8180920]Passive — a sensing interface configured to analyze traffic in a passive deployment.
  
             	[bookmark: pgfId-8180924]Configuring Passive Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8180932]Inline — a sensing interface configured to handle traffic in an inline deployment.
  
             	[bookmark: pgfId-8180936]Configuring Inline Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8180944]Switched — an interface configured to switch traffic in a Layer 2 deployment.
  
             	[bookmark: pgfId-8180948]Configuring Switched Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8180956]Routed — an interface configured to route traffic in a Layer 3 deployment.
  
             	[bookmark: pgfId-8180960]Configuring Routed Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8180968]HA — an interface configured on each member of a clustered pair of devices to act as a redundant communications channel between the devices; also called a high availability link interface.
  
             	[bookmark: pgfId-8180972]Configuring HA Link Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8180980]Aggregate — multiple physical interfaces configured as a single logical link.
  
             	[bookmark: pgfId-8180984]Setting Up Aggregate Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8180992]Aggregate Switched — multiple physical interfaces configured as a single logical link in a Layer 2 deployment.
  
             	[bookmark: pgfId-8180996]Adding Aggregate Switched Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8181004]Aggregate Routed — multiple physical interfaces configured as a single logical link in a Layer 3 deployment.
  
             	[bookmark: pgfId-8181008]Adding Aggregate Routed Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8181016]Hybrid — a logical interface configured to bridge traffic between a virtual router and a virtual switch.
  
             	[bookmark: pgfId-8181020]Adding Logical Hybrid Interfaces
  
            
 
            
               
             	[bookmark: pgfId-8181031]ASA FirePOWER — an interface configured on an ASA device with the ASA FirePOWER module installed.
  
             	[bookmark: pgfId-8181038]Managing Cisco ASA with FirePOWER Services Interfaces
  
            
 
            
          
 
         
 [bookmark: pgfId-8136203]Note that you can only configure a total of 1024 interfaces on a FirePOWER managed device.
 
          
           
         
 
         
 [bookmark: pgfId-7841367]Note The Defense Center does not display ASA interfaces when the ASA FirePOWER device is deployed in SPAN port mode.
 
          
          
 
         

 [bookmark: pgfId-7576517]See the following sections for details on the different ways you can configure interfaces on a device:
 
          
          	 [bookmark: pgfId-7686545]Configuring HA Link Interfaces
 
          	 [bookmark: pgfId-7686575]MTU Ranges for Managed Devices
 
          	 [bookmark: pgfId-7840417]Managing Cisco ASA with FirePOWER Services Interfaces
 
          	 [bookmark: pgfId-7686594]Disabling Interfaces
 
          	 [bookmark: pgfId-7707542]Preventing Duplicate Connection Logging
 
          	 [bookmark: pgfId-7686549]Setting Up an IPS Device
 
          	 [bookmark: pgfId-7227600]Setting Up Virtual Switches
 
          	 [bookmark: pgfId-7227605]Setting Up Virtual Routers
 
          	 [bookmark: pgfId-8014310]Setting Up Aggregate Interfaces
 
          	 [bookmark: pgfId-7250234]Setting Up Hybrid Interfaces
 
         
 
          
           [bookmark: pgfId-7269117][bookmark: 25902][bookmark: 77815]Configu[bookmark: marker-7372002]r[bookmark: marker-7716191]ing HA Link Interfaces
 
          [bookmark: pgfId-7269154]License: Any
 
          [bookmark: pgfId-7501444]Supported Devices: Series 3
 
          [bookmark: pgfId-7269172]After you establish a device cluster, you can configure a physical interface as a high availability (HA) link interface. This link acts as a redundant communications channel for sharing health information between the clustered devices. When you configure an HA link interface on one device, you automatically configure an interface on the second device. You must configure both HA links on the same broadcast domain. See Clustering Devices for more information.
 
          [bookmark: pgfId-8219344]Dynamic NAT relies on dynamically allocating IP addresses and ports to map to other IP addresses and ports. Without an HA link, these mappings are lost in a failover, causing all translated connections to fail as they are routed through the now active device in the cluster.
 
           
            
          
 
          
 
           
           [bookmark: pgfId-8220280] 
           Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
           How Snort Restarts Affect Traffic. 
            
            
 
           
 
          
 
          [bookmark: pgfId-8216844]To configure an HA link interface:
 
          [bookmark: pgfId-7271072]Access: Admin/Network Admin
 
          
 
          [bookmark: pgfId-7271095]Step 1 Select Devices > Device Management.
 
          [bookmark: pgfId-7271096]The Device Management page appears.
 ). 
          
 
          [bookmark: pgfId-7271101]The Interfaces tab for that device appears.
 ). 
          
 
          [bookmark: pgfId-7271106]The Edit Interface pop-up window appears.
 
          [bookmark: pgfId-7282057]Step 4 Click HA Link to display the HA link options.
 
          [bookmark: pgfId-7271157]Step 5 Select the Enabled check box to allow the HA link interface to provide link.
 
          [bookmark: pgfId-7271152]If you clear the check box, the interface becomes disabled and administratively taken down.
 
          [bookmark: pgfId-7271107]Step 6 From the Mode drop-down list, select an option to designate the link mode or select Autonegotiation to specify that the interface is configured to autonegotiate speed and duplex settings.
 
          [bookmark: pgfId-7271108]Step 7 From the MDI/MDIX drop-down list, select an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX.
 
          [bookmark: pgfId-7271109]Normally, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.
 
          [bookmark: pgfId-7420675]Step 8 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed.
 
          [bookmark: pgfId-7692263]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
          [bookmark: pgfId-7692270]Step 9 Click Save.
 
          [bookmark: pgfId-7692271]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
          [bookmark: pgfId-7877665]
 
           
           
 
          
 
          
 
         
 
          
           [bookmark: pgfId-7686469][bookmark: 38265]MTU Ranges for Managed Devices
 
          [bookmark: pgfId-7686470]License: Any
 
           
            
          
 
          
 
           
           [bookmark: pgfId-8220260] 
           Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
           How Snort Restarts Affect Traffic. 
            
            
 
           
 
          
 
          [bookmark: pgfId-8217409]Note that for Cisco NGIPS for Blue Coat X-Series, you configure the interface MTU using the Cisco NGIPS for Blue Coat X-Series CLI. See the Cisco NGIPS for Blue Coat X-Series Installation Guide for more information.
 
           
            
          
 
          
 
          [bookmark: pgfId-8217414]Note Because the system automatically trims 18 bytes from the configured MTU value, any value below 1298 does not comply with the minimum IPv6 MTU setting of 1280, and any value below 594 does not comply with the minimum IPv4 MTU setting of 576. For example, the system automatically trims a configured value of 576 to 558.
 
           
           
 
          
 
          
 
           
            
             
             [bookmark: pgfId-8217370]Table 4-7 MTU Range by Device 
 
             
             
              
              	 
                
                [bookmark: pgfId-8217374]On this Model Device... 
               
  
              	 
                
                [bookmark: pgfId-8217376]The MTU Range is... 
               
  
             
 
              
              	[bookmark: pgfId-8217381]Series 2, except 3D6500, 3D9900
  
              	[bookmark: pgfId-8217383]576-1518 (all interfaces, inline sets)
  
             
 
              
              	[bookmark: pgfId-8217385]3D6500, 3D9900, virtual
  
              	[bookmark: pgfId-8217387]576-9018 (all interfaces, inline sets)
  
             
 
              
              	[bookmark: pgfId-8217392]Series 3
  
              	[bookmark: pgfId-8217394]576-9234 (management interface)
576-10172 (inline sets, passive interface)
576-9922 (all others)
  
             
 
             
           
 
          
 
         
 
          
           [bookmark: pgfId-7834362][bookmark: 48241]Managing Cisco ASA with FirePOWER Services Interfaces[bookmark: marker-7891488]
 
          [bookmark: pgfId-7834418]License: Protection
 
          [bookmark: pgfId-7834442]Supported Devices: ASA FirePOWER
 
          [bookmark: pgfId-7840578]When editing an ASA FirePOWER interface, you can configure only the interface’s security zone from the FireSIGHT Defense Center. See Working with Security Zones for more information.
 
          [bookmark: pgfId-7840771]You fully configure ASA FirePOWER interfaces using the ASA-specific software and CLI. If you edit an ASA FirePOWER device and switch from multiple context mode to single context mode (or visa versa), the device renames all of its interfaces. You must reconfigure all FireSIGHT System security zones, correlation rules, and related configurations to use the updated ASA FirePOWER interface names. For more information about ASA FirePOWER interface configuration, see the ASA documentation.
 
           
            
          
 
          
 
          [bookmark: pgfId-7840588]Note You cannot change the type of ASA FirePOWER interface, nor can you disable the interface from the FireSIGHT Defense Center.
 
           
           
 
          
 
          
 
          [bookmark: pgfId-7834678]To edit an ASA FirePOWER Interface:
 
          [bookmark: pgfId-7834747]Access: Admin/Network Admin
 
          
 
          [bookmark: pgfId-7834775]Step 1 Select Devices > Device Management.
 
          [bookmark: pgfId-7834802]The Device Management page appears.
 ). 
          
 
          [bookmark: pgfId-7834849]The Interfaces tab for that device appears.
 ). 
          
 
          [bookmark: pgfId-7834896]The Edit Interface pop-up window appears.
 
          [bookmark: pgfId-7840692]Step 4 From the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
          [bookmark: pgfId-7840729]Step 5 Click Save.
 
          [bookmark: pgfId-7840750]The security zone is configured. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
          [bookmark: pgfId-7877714]
 
           
           
 
          
 
          
 
         
 
          
           [bookmark: pgfId-7834366][bookmark: 56238]Disabling Inte[bookmark: marker-7834365]rfaces
 
          [bookmark: pgfId-7809173]License: Any
 
          [bookmark: pgfId-7809191]You can disable an interface by setting the interface type to None. Disabled interfaces appear grayed out in the interface list.
 
           
            
          
 
          
 
          [bookmark: pgfId-7850607]Note You cannot change the type of an ASA FirePOWER interface, nor can you disable the interface from the FireSIGHT Defense Center.
 
           
           
 
          
 
          
 
          [bookmark: pgfId-7809175]To disable an interface:
 
          [bookmark: pgfId-7809176]Access: Admin/Network Admin
 
          
 
          [bookmark: pgfId-7281941]Step 1 Select Devices > Device Management.
 
          [bookmark: pgfId-7281942]The Device Management page appears.
 ). 
          
 
          [bookmark: pgfId-7281947]The Interfaces tab for that device appears.
 ). 
          
 
          [bookmark: pgfId-7281952]The Edit Interface pop-up window appears.
 
          [bookmark: pgfId-7281953]Step 4 Click None.
 
          [bookmark: pgfId-7281958]Step 5 Click Save.
 
          [bookmark: pgfId-7707660]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
          [bookmark: pgfId-7877729]
 
           
           
 
          
 
          
 
         
 
          
           [bookmark: pgfId-7707665][bookmark: 94435]Preventing Duplicate Connection Logging
 
          [bookmark: pgfId-7809328]License: Any
 
          [bookmark: pgfId-7707666]When you update a security zone object, the system saves a new revision of the object. As a result, if you have managed devices in the same security zone that have different revisions of the security zone object configured in the interfaces, you may log what appear to be [bookmark: marker-7707667]duplicate connections. 
 
          [bookmark: pgfId-7706830]If you notice duplicate connection reporting, you can update all managed devices to use the same revision of the object. 
 
          [bookmark: pgfId-7706914]To synchronize security zone object revisions across devices:
 
          [bookmark: pgfId-7809362]Access: Admin/Network Admin
 
          
 
          [bookmark: pgfId-7707175]Step 1 Select Devices > Device Management.
 
          [bookmark: pgfId-7707176]The Device Management page appears.
 
           
            
          
 
          
 
           
           [bookmark: pgfId-7707199] 
           Caution You must not reapply managed device changes to any device until you have edited the zone setting for interfaces on all devices you want to sync. 
            
            
 
           
 
          
 ). 
          
 
          [bookmark: pgfId-7707181]The Interfaces tab for that device appears.
 
          [bookmark: pgfId-7706915]Step 3 [bookmark: 14634]For each interface logging duplicate connection events, change the Security Zone to another zone, click Save, then change it back to the desired zone, and click Save again. 
 
          [bookmark: pgfId-7707279]Step 4 Repeat steps 2 through 3 for each device logging duplicate events. 
 
          [bookmark: pgfId-7707353]Step 5 After all interfaces on all devices have been edited, apply device changes to all managed devices at once. 
 
          [bookmark: pgfId-7686425]
 
           
           
 
          
 
          
 
          [bookmark: pgfId-7877742]
 
         
 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-6753877][bookmark: 93240]Setti[bookmark: marker-7214452]ng Up an IPS Device 
      
      
 
     
 
 
    [bookmark: pgfId-7219972]You can configure your device in either a passive or inline IPS deployment. In a passive deployment, you deploy the system out of band from the flow of network traffic. In an inline deployment, you configure the system transparently on a network segment by binding two ports together.
 
    [bookmark: pgfId-7178927]The following sections describe configuring your device for passive and inline deployments of the FireSIGHT System:
 
     
     	 [bookmark: pgfId-7178931]Understanding Passive IPS Deployments
 
     	 [bookmark: pgfId-7179609]Configuring Passive Interfaces
 
     	 [bookmark: pgfId-7179613]Understanding Inline IPS Deployments
 
     	 [bookmark: pgfId-7179617]Configuring Inline Interfaces
 
     	 [bookmark: pgfId-7179157]Configuring Inline Sets
 
     	 [bookmark: pgfId-7253688]Configuring Cisco NGIPS for Blue Coat X-Series Interfaces
 
    
 
   
 
    
     [bookmark: pgfId-7183517][bookmark: 20977]Understanding Passive IPS De[bookmark: marker-7214457]ployments
 
    [bookmark: pgfId-7183518]License: Protection
 
    [bookmark: pgfId-7284399]In a passive IPS deployment, the FireSIGHT System monitors traffic flowing across a network using a switch SPAN or mirror port. The SPAN or mirror port allows for traffic to be copied from other ports on the switch. This provides the system visibility within the network without being in the flow of network traffic. When configured in a passive deployment, the system cannot take certain actions such as blocking or shaping traffic. Passive interfaces receive all traffic unconditionally and no traffic received on these interfaces is retransmitted.
 
     
      
    
 
    
 
    [bookmark: pgfId-7286879]Note Outbound traffic includes flow control packets. Because of this, passive interfaces on your appliances may show outbound traffic and, depending on your configuration, generate events; this is expected behavior.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7284403][bookmark: 40628]Configuring Pa[bookmark: marker-7284401]ssive Interfaces
 
    [bookmark: pgfId-7199518]License: Protection
 
    [bookmark: pgfId-7201609]You can configure one or more physical ports on a managed device as passive interfaces.
 
    [bookmark: pgfId-7253787]You configure Cisco NGIPS for Blue Coat X-Series interfaces as either passive or inline when installing the Cisco package. You cannot use the FireSIGHT System web interface to reconfigure Cisco NGIPS for Blue Coat X-Series interfaces. For more information, see Configuring Cisco NGIPS for Blue Coat X-Series Interfaces.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7302618] 
     Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7201611]To configure a passive interface:
 
    [bookmark: pgfId-7177138]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7177139]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7215572]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7286815]The Interfaces tab appears.
 ). 
    
 
    [bookmark: pgfId-7177150]The Edit Interface pop-up window appears.
 
    [bookmark: pgfId-7177151]Step 4 Click Passive to display the passive interface options.
 
    [bookmark: pgfId-7177152]Step 5 Optionally, from the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
    [bookmark: pgfId-7177157]Step 6 Select the Enabled check box to allow the passive interface to monitor traffic.
 
    [bookmark: pgfId-7177158]If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.
 
    [bookmark: pgfId-7177159]Step 7 From the Mode drop-down list, select an option to designate the link mode or select Autonegotiation to specify that the interface is configured to automatically negotiate speed and duplex settings. Note that mode settings are available only for copper interfaces.
 
     
      
    
 
    
 
    [bookmark: pgfId-7259240]Note Interfaces on 8000 Series appliances do not support half-duplex options. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7217952]Step 8 From the MDI/MDIX drop-down list, select an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX. Note that MDI/MDIX settings are available only for copper interfaces.
 
    [bookmark: pgfId-7217953]By default, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.
 
    [bookmark: pgfId-7220636]Step 9 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed.
 
    [bookmark: pgfId-7236200]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
    [bookmark: pgfId-7236201]Step 10 Click Save.
 
    [bookmark: pgfId-7249497]The passive interface is configured. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7276391]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7249503][bookmark: 56512]Understanding Inline IPS De[bookmark: marker-7249502]ployments
 
    [bookmark: pgfId-7173929]License: Protection
 
    [bookmark: pgfId-7173941]In an inline IPS deployment, you configure the FireSIGHT System transparently on a network segment by binding two ports together. This allows the system to be installed in any network environment without the configuration of adjacent network devices. Inline interfaces receive all traffic unconditionally, but all traffic received on these interfaces is retransmitted out of an inline set unless explicitly dropped.
 
   
 
    
     [bookmark: pgfId-7199573][bookmark: 52730]Configuring Inline Inte[bookmark: marker-7214480]rfaces
 
    [bookmark: pgfId-7199578]License: Protection
 
    [bookmark: pgfId-7199579]You can configure one or more physical ports on a managed device as inline interfaces. You must assign a pair of inline interfaces to an inline set before they can handle traffic in an inline deployment.
 
    [bookmark: pgfId-7259329]Note that the system warns you if you set the interfaces in an inline pair to different speeds or if the interfaces negotiate to different speeds.
 
    [bookmark: pgfId-7260803]You configure Cisco NGIPS for Blue Coat X-Series interfaces as either passive or inline when installing the Cisco package. You cannot use the FireSIGHT System web interface to reconfigure Cisco NGIPS for Blue Coat X-Series interfaces. For more information, see Configuring Cisco NGIPS for Blue Coat X-Series Interfaces.
 
     
      
    
 
    
 
    [bookmark: pgfId-7197540]Note If you configure an interface as an inline interface, the adjacent port on its NetMod automatically becomes an inline interface as well to complete the pair.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7225406]To configure inline interfaces on a virtual device, you must create the inline pair using adjacent interfaces.
 
    [bookmark: pgfId-7174401]To configure an inline interface:
 
    [bookmark: pgfId-7174482]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7177277]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7177278]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7286780]The Interfaces tab appears.
 ). 
    
 
    [bookmark: pgfId-7177289]The Edit Interface pop-up window appears.
 
    [bookmark: pgfId-7189895]Step 4 Click Inline to display the inline interface options.
 
    [bookmark: pgfId-7177290]Step 5 Optionally, from the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
    [bookmark: pgfId-7177650]Step 6 From the Inline Set drop-down list, select an existing inline set or select New to add a new inline set.
 
    [bookmark: pgfId-7190169]Note that if you add a new inline set, you must configure it on the Device Management page (Devices > Device Management > Inline Sets) after you set up the inline interface. For more information, see Adding Inline Sets.
 
    [bookmark: pgfId-7177645]Step 7 Select the Enabled check box to allow the inline interface to handle traffic.
 
    [bookmark: pgfId-7177296]If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.
 
    [bookmark: pgfId-7177297]Step 8 From the Mode drop-down list, select an option to designate the link mode or select Autonegotiation to specify that the interface is configured to automatically negotiate speed and duplex settings. Note that Mode settings are available only for copper interfaces.
 
     
      
    
 
    
 
    [bookmark: pgfId-7259096]Note Interfaces on 8000 Series appliances do not support half-duplex options. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7177298]Step 9 From the MDI/MDIX drop-down list, select an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX. Note that MDI/MDIX settings are available only for copper interfaces.
 
    [bookmark: pgfId-7177299]By default, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.
 
    [bookmark: pgfId-7177340]Step 10 Click Save.
 
    [bookmark: pgfId-7177320]The inline interface is configured. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7276414]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7177421][bookmark: 26259]Configuring In[bookmark: marker-7214486]line Sets
 
    [bookmark: pgfId-7177422]License: Protection
 
    [bookmark: pgfId-7202005]Before you can use inline interfaces in an inline deployment, you must configure inline sets and assign inline interface pairs to them. An inline set is a grouping of one or more inline interface pairs on a device; an inline interface pair can belong to only one inline set at a time.
 
    [bookmark: pgfId-7293889]You can configure the interfaces on your managed device to route traffic between a host on your network and external hosts using different inline interface pairs, depending on whether the device traffic is inbound or outbound. This is an asynchronous routing[bookmark: marker-7296275] configuration. If you deploy asynchronous routing but you include only one interface pair in an inline set, the device might not correctly analyze your network traffic because it might see only half of the traffic. 
 
    [bookmark: pgfId-7306986]Adding multiple inline interface pairs to the same inline interface set allows the system to identify the inbound and outbound traffic as part of the same traffic flow. For passive interfaces, you can also achieve this by including the interface pairs in the same security zone.
 
     
     [image: ] 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7293252]Note If you assign multiple interface pairs to a single inline interface set but you experience issues with dupl[bookmark: marker-7296280]icate traffic, reconfigure to help the system uniquely identify packets. For example, you could reassign your interface pairs to separate inline sets or modify your security zones.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7290386]For devices with inline sets, a software bridge is automatically set up to transport packets after the device restarts. If the device is restarting, there is no software bridge running anywhere. If you enable bypass mode on the inline set, it goes into hardware bypass while the device is restarting. In that case, you may lose a few seconds of packets as the system goes down and comes back up, due to renegotiation of link with the device. However, the system will pass traffic while Snort is restarting.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7302638] 
     Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7301651]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7301655]Viewing Inline Sets
 
     	 [bookmark: pgfId-7177868]Adding Inline Sets
 
     	 [bookmark: pgfId-7181611]Configuring Advanced Inline Set Options
 
     	 [bookmark: pgfId-7186960]Deleting Inline Sets
 
    
 
     
      [bookmark: pgfId-7186044][bookmark: 83584]Viewing Inline Sets
 
     [bookmark: pgfId-7286750]License: Protection
 
     [bookmark: pgfId-7286751]The Inline Sets tab of the Device Management page displays a list of all inline sets you have configured on a device. Note that you cannot configure inline sets to go into by[bookmark: marker-7286752]pass mode on a virtual device or Cisco NGIPS for Blue Coat X-Series. The Inline Sets Table View Fields table includes summary information about each set.
 
     [bookmark: pgfId-7289172]
 
      
       
        
        [bookmark: pgfId-7289153]Table 5-1 Inline Sets Table View Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-7289157]Field 
          
  
         	 
           
           [bookmark: pgfId-7289159]Description 
          
  
        
 
         
         	[bookmark: pgfId-7289161]Name
  
         	[bookmark: pgfId-7289163]The name of the inline set.
  
        
 
         
         	[bookmark: pgfId-7289165]Interface Pairs
  
         	[bookmark: pgfId-7289167]A list of all pairs of inline interfaces assigned to the inline set. A pair is not available when you disable either interface in the pair from the Interfaces tab.
  
        
 
         
         	[bookmark: pgfId-7289169]Bypass
  
         	[bookmark: pgfId-7289171]The configured bypass mode of the inline set.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7289177][bookmark: 58177]Adding I[bookmark: marker-7289175]nline Sets
 
     [bookmark: pgfId-7286720]License: Protection
 
     [bookmark: pgfId-7289988]You can add inline sets from the Inline Sets tab of the Device Management page or you can add inline sets as you configure inline interfaces. 
 
     [bookmark: pgfId-7290013]You can assign only inline interface pairs to an inline set. If you want to create an inline set before you configure the inline interfaces on your managed devices, you can create an empty inline set and add interfaces to it later. 
 
     [bookmark: pgfId-7177427]To add an inline set:
 
     [bookmark: pgfId-7177428]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7177775]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7177776]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7286701]The Interfaces tab appears.
 
     [bookmark: pgfId-7286702]Step 3 Click Inline Sets.
 
     [bookmark: pgfId-7286685]The Inline Sets tab appears.
 
     [bookmark: pgfId-7286686]Step 4 Click Add Inline Set.
 
     [bookmark: pgfId-7177804]The Add Inline Set pop-up window appears.
 
     [bookmark: pgfId-7177805]Step 5 In the Name field, type a name for the inline set. You can use alphanumeric characters and spaces.
 
     [bookmark: pgfId-7177806]Step 6 You have two options for selecting inline interface pairs to add to the inline set:
 
      
       
       	 [bookmark: pgfId-7191045]Next to  Interfaces , select one or more inline interface pairs, then click the add selected icon (
 
      
 
      [image: ] ). Use Ctrl or Shift to select multiple inline interface pairs. 
     
 
      
       
       	 [bookmark: pgfId-7191230]To add all interface pairs to the inline set, click the add all icon (
 
      
 
      [image: ] ). 
     
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7286673]Step 7 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed.
 
    [bookmark: pgfId-7235598]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
    [bookmark: pgfId-7300242]Step 8 [bookmark: marker-7300241]Optionally, select Failsafe to specify that traffic is allowed to bypass detection and continue through the device. Managed devices monitor internal traffic buffers and bypass detection if those buffers are full.
 
    [bookmark: pgfId-7300243]Enabling Failsafe on a device with inline sets greatly decreases the risk of dropped packets if the internal traffic buffers are full, but your device may still drop packets in certain conditions. In the worst case, your device may experience a temporary network outage.
 
    [bookmark: pgfId-7300247]Note that only Series 3 devices support this option.
 
    [bookmark: pgfId-7300055]Step 9 Select the bypass mode to configure how the relays in the inline interfaces respond when an interface fails:
 
     
      
      	 [bookmark: pgfId-7300655]Select  Bypass to allow traffic to continue to pass through the interfaces.
 
      	 [bookmark: pgfId-7300657]Select  Non-Bypass to block traffic. 
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7240210]Note In bypass mode, you may lose a few packets when you reboot the appliance. Also note that you cannot configure bypass mode for inline sets on clustered devices, inline sets on a virtual device or Cisco NGIPS for Blue Coat X-Series, for non-bypass NetMods on 8000 Series devices, or for SFP modules on 3D7115 or 3D7125 devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7228166]Step 10 Click OK.
 
    [bookmark: pgfId-7177817]The inline set is added. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-7177818]Tip To configure advanced settings for the inline set, such as tap mode, link state propagation, and transparent inline mode, see Configuring Advanced Inline Set Options.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7276439]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7177430][bookmark: 60820]Configuring Advanced Inlin[bookmark: marker-7214527]e Set Options
 
    [bookmark: pgfId-7178143]License: Protection
 
    [bookmark: pgfId-7240539]Supported Devices: feature dependent
 
    [bookmark: pgfId-7185964]There are a number of options you may consider as you configure inline sets. See the sections below for more information about each option.
 
    [bookmark: pgfId-7187561][bookmark: 52999]Tap M[bookmark: marker-7214532]ode
 
    [bookmark: pgfId-7240568]Supported Devices: Series 3
 
    [bookmark: pgfId-7239541]Tap mode is available on Series 3 devices when you create an inline or inline with fail-open interface set.
 
    [bookmark: pgfId-7187562]With tap mode, the device is deployed inline, but instead of the packet flow passing through the device, a copy of each packet is sent to the device and the network traffic flow is undisturbed. Because you are working with copies of packets rather than the packets themselves, rules that you set to drop and rules that use the replace keyword do not affect the packet stream. However, rules of these types do generate intrusion events when they are triggered, and the table view of intrusion events indicates that the triggering packets would have dropped in an inline deployment.
 
    [bookmark: pgfId-7185800]There are benefits to using tap mode with devices that are deployed inline. For example, you can set up the cabling between the device and the network as if the device were inline and analyze the kinds of intrusion events the device generates. Based on the results, you can modify your intrusion policy and add the drop rules that best protect your network without impacting its efficiency. When you are ready to deploy the device inline, you can disable tap mode and begin dropping suspicious traffic without having to reconfigure the cabling between the device and the network.
 
    [bookmark: pgfId-7246663]Note that you cannot enable this option and strict TCP enforcement on the same inline set.
 
    [bookmark: pgfId-7185801]Propag[bookmark: marker-7214537]ate Link State
 
    [bookmark: pgfId-7244849]Supported Devices: Series 2, Series 3
 
    [bookmark: pgfId-7185802]Link state propagation is a feature for inline sets configured in bypass mode so both pairs of an inline set track state. Link state propagation is available for both copper and fiber configurable bypass interfaces.
 
    [bookmark: pgfId-7185807]Link state propagation automatically brings down the second interface in the inline interface pair when one of the interfaces in an inline set goes down. When the downed interface comes back up, the second interface automatically comes back up, also. In other words, if the link state of one interface changes, the appliance senses the change and updates the link state of the other interface to match it. Note that appliances require up to 4 seconds to propagate link state changes.
 
     
      
    
 
    
 
    [bookmark: pgfId-7246310]Note When link state propagation triggers, fiber inline sets configured as fail-open on Series 2 devices activate hardware bypass mode. In this case, the interface cards involved do not come out of bypass automatically; you must bring them out of bypass mode manually. For more information about fiber interfaces in inline sets and hardware bypass, see Removing Bypass Mode on Fiber Inline Sets Configured to Fail Open.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7185808]Link state propagation is especially useful in resilient network environments where routers are configured to reroute traffic automatically around network devices that are in a failure state.
 
    [bookmark: pgfId-7250555]You cannot disable link state propagation for inline sets configured on clustered devices.
 
    [bookmark: pgfId-7226861]Note that virtual devices, Cisco NGIPS for Blue Coat X-Series, and Cisco ASA with FirePOWER Services do not support link state propagation.
 
    [bookmark: pgfId-7185810]Transparen[bookmark: marker-7185809]t Inline Mode
 
    [bookmark: pgfId-7185812]Transparent Inline Mode option allows the device to act as a “bump in the wire” and means that the device forwards all the network traffic it sees, regardless of its source and destination. Note that you cannot disable this option on Series 3 or 3D9900 devices.
 
    [bookmark: pgfId-7246479]Strict TCP Enforcement
 
    [bookmark: pgfId-7246483]Supported Devices: Series 3
 
    [bookmark: pgfId-7246485]To maximize TCP security, you can enable strict enforcement[bookmark: marker-7246484], which blocks connections where the three-way handshake was not completed. Strict enforcement also blocks:
 
     
     	 [bookmark: pgfId-7227432]non-SYN TCP packets for connections where the three-way handshake was not completed
 
     	 [bookmark: pgfId-7227433]non-SYN/RST packets from the initiator on a TCP connection before the responder sends the SYN-ACK
 
     	 [bookmark: pgfId-7227434]non-SYN-ACK/RST packets from the responder on a TCP connection after the SYN but before the session is established
 
     	 [bookmark: pgfId-7227435]SYN packets on an established TCP connection from either the initiator or the responder
 
    
 
    [bookmark: pgfId-7228012]Note that Series 2, virtual devices, and Cisco NGIPS for Blue Coat X-Series do not support this option. In addition, you cannot enable this option and tap mode on the same inline set.
 
    [bookmark: pgfId-7182075][bookmark: 47307]To configure advanced inline set options:
 
    [bookmark: pgfId-7179330]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7179345]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7179346]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7286662]The Interfaces tab appears.
 
    [bookmark: pgfId-7286663]Step 3 Click Inline Sets.
 
    [bookmark: pgfId-7286651]The Inline Sets tab appears.
 ). 
    
 
    [bookmark: pgfId-7192177]The Edit Inline Set pop-up window appears.
 
    [bookmark: pgfId-7286642]Step 5 Click Advanced.
 
    [bookmark: pgfId-7286643]The Advanced tab appears.
 
    [bookmark: pgfId-7286647]Step 6 Optionally, select Tap Mode to enable tap mode on the inline interfaces of Series 3 devices.
 
    [bookmark: pgfId-7246052]Note that virtual devices, Cisco NGIPS for Blue Coat X-Series, and Series 2 devices other than 3D9900 do not support this option. In addition, you cannot enable Tap Mode and Strict TCP Enforcement on the same inline set.
 
    [bookmark: pgfId-7245017]Step 7 Optionally, select Propagate Link State on Series 2 or Series 3 devices. This option is especially useful if the routers on your network are able to reroute traffic around a network device that is down.
 
    [bookmark: pgfId-7250660]You cannot disable link state propagation for inline sets configured on clustered devices.
 
    [bookmark: pgfId-7245065]Note that virtual devices and Cisco NGIPS for Blue Coat X-Series do not support this option.
 
    [bookmark: pgfId-7245484]Step 8 Optionally, select Strict TCP Enforcement to enable strict TCP enforcement on Series 3 devices.
 
    [bookmark: pgfId-7245489]Note that Series 2, virtual devices, and Cisco NGIPS for Blue Coat X-Series do not support this option. In addition, you cannot enable Strict TCP Enforcement and Tap Mode on the same inline set.
 
    [bookmark: pgfId-7300581]Step 9 Optionally, select Transparent Inline Mode.
 
    [bookmark: pgfId-7300585]Note that you cannot disable this option on Series 3 devices.
 
    [bookmark: pgfId-7300586]Step 10 Click OK.
 
    [bookmark: pgfId-7190752]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7276459]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7247526][bookmark: 85469]Removing Bypass [bookmark: marker-7247525]Mode on Fiber Inline Sets Configured to Fail Open
 
    [bookmark: pgfId-7247530]License: Protection
 
    [bookmark: pgfId-7247531]Supported Devices: Series 2
 
    [bookmark: pgfId-7247532]When link state propagation is enabled on a Series 2 device with a fiber inline set configured to fail open and the device goes into bypass mode, all network traffic passes through the inline set without being analyzed. When the links restore, most fiber inline sets configured to fail open do not return from bypass automatically. You can use a command line tool to force the inline set out of bypass mode.
 
    [bookmark: pgfId-7247533]This tool works on inline sets with fiber inline interfaces configured to fail open. It is not necessary to use this tool on inline sets with copper inline interfaces set to fail open. 
 
     
      
    
 
    
 
    [bookmark: pgfId-7247534]Note Contact Support if you are having issues with inline sets configured to fail open on your device.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7247535]To force a fiber inline set configured to fail open out of bypass mode on a device:
 
    [bookmark: pgfId-7247536]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7247537]Step 1 Open a terminal window on your device and sign in as the admin user.
 
    [bookmark: pgfId-7247539]Step 2 Enter the following at the command line:
 
     
     [bookmark: pgfId-7247540]sudo /var/sf/bin/unbypass_cards.sh 
    
 
    [bookmark: pgfId-7247541]You are prompted for your password.
 
    [bookmark: pgfId-7247542]Step 3 When the interfaces switch out of bypass mode, a message in syslog indicates the device is analyzing traffic. For example:
 
     
     [bookmark: pgfId-7247510]Fiber pair has been reset by un_bypass 
    
 
    [bookmark: pgfId-7276484]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7177435][bookmark: 33940]Deleting Inlin[bookmark: marker-7214564]e Sets
 
    [bookmark: pgfId-7177436]License: Protection
 
    [bookmark: pgfId-7177437]When you delete an inline set, any inline interfaces assigned to the set become available for inclusion in another set. The interfaces are not deleted.
 
    [bookmark: pgfId-7177438]To delete an inline set:
 
    [bookmark: pgfId-7186602]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7186603]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7186604]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7286634]The Interfaces tab appears.
 
    [bookmark: pgfId-7286635]Step 3 Click Inline Sets.
 
    [bookmark: pgfId-7286619]The Inline Sets tab appears.
 ). 
    
 
    [bookmark: pgfId-7219915]Step 5 When prompted, confirm that you want to delete the inline set.
 
    [bookmark: pgfId-7253645]The inline set is deleted. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7276500]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7260069][bookmark: 29439]Configuring Cisco NGIPS for Blue Coat X-Series Interf[bookmark: marker-7262418]aces
 
    [bookmark: pgfId-7260939]License: Protection
 
    [bookmark: pgfId-7260945]Supported Devices: X-Series
 
    [bookmark: pgfId-7260072]You create passive or inline interfaces when you deploy Cisco NGIPS for Blue Coat X-Series package, or after the package has been installed. When you add Cisco NGIPS for Blue Coat X-Series to the Defense Center, these interfaces are already configured. Cisco NGIPS for Blue Coat X-Series does not support advanced configuration options.
 
    [bookmark: pgfId-7261462]You cannot reconfigure Cisco NGIPS for Blue Coat X-Series interfaces using the FireSIGHT System web interface. To reconfigure, you must first delete the current interface from the Defense Center, then create a new interface. For more information on creating and deleting interfaces, see the Cisco NGIPS for Blue Coat X-Series Installation Guide.
 
    [bookmark: pgfId-7256922]To configure an interface on Cisco NGIPS for Blue Coat X-Series:
 
    [bookmark: pgfId-7256923]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7256924]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7256925]The Device Management page appears.
 ). 
    
 ) for all Cisco NGIPS for Blue Coat X-Series interfaces. 
    
 ). 
    
 
    [bookmark: pgfId-7256954]Step 4 From the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
    [bookmark: pgfId-7256955]Step 5 Optionally, for an inline interface, from the Inline Set drop-down list, select an existing inline set or select New to add a new inline set.
 
    [bookmark: pgfId-7256956]Note that if you add a new inline set, you must configure it on the Device Management page (Devices > Device Management > Inline Sets) after you set up the inline interface. For more information, see Adding Inline Sets.
 
    [bookmark: pgfId-7257536]Step 6 Click Save.
 
    [bookmark: pgfId-7261983]The interface is configured. Note that your changes do not take effect until you apply the device configurations by clicking Apply Changes at top right of the menu bar.
 
    [bookmark: pgfId-7276512]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7211269]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-6753877][bookmark: 81503]Setting Up Virt[bookmark: marker-7203521]ual Switches 
      
      
 
     
 
 
    [bookmark: pgfId-7190777]You can configure a managed device in a Layer 2 deployment so that it provides packet switching between two or more networks. In a Layer 2 deployment, you can configure virtual switches on managed devices to operate as standalone broadcast domains, dividing your network into logical segments. A virtual switch uses the media access control (MAC) address from a host to determine where to send packets.
 
    [bookmark: pgfId-7201267]When you configure a virtual switch, the switch initially broadcasts packets through every available port on the switch. Over time, the switch uses tagged return traffic to learn which hosts reside on the networks connected to each port.
 
    [bookmark: pgfId-7186646]A virtual switch must contain two or more switched interfaces to handle traffic. For each virtual switch, traffic becomes limited to the set of ports configured as switched interfaces. For example, if you configure a virtual switch with four switched interfaces, packets sent in through one port for broadcast can only be sent out of the remaining three ports on the switch.
 
    [bookmark: pgfId-7243072]When you configure a physical switched interface, you must assign it to a virtual switch. You can also define additional logical switched interfaces on a physical port as needed. On Series 3 managed devices, you can group multiple physical interfaces into a single logical switched interface called a link aggregation group (LAG). This single aggregate logical link provides higher bandwidth, redundancy, and load-balancing between two endpoints. 
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7243080] 
     Caution If a Layer 2 deployment fails for any reason, the device no longer passes traffic. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7188015]See the following sections for more information about configuring a Layer 2 deployment:
 
     
     	 [bookmark: pgfId-7188065]Configuring Switched Interfaces
 
     	 [bookmark: pgfId-7188069]Configuring Virtual Switches
 
     	 [bookmark: pgfId-7241044]Configuring LAGs
 
    
 
   
 
    
     [bookmark: pgfId-7188071]Configuring [bookmark: Configuring Switched Interfaces]Switch[bookmark: marker-7203528]ed Interfaces
 
    [bookmark: pgfId-7235724]License: Control
 
    [bookmark: pgfId-7235728]Supported Devices: Series 3
 
    [bookmark: pgfId-7235729]You can set up switched interfaces to have either physical or logical configurations. You can configure physical switched interfaces for handling untagged VLAN traffic. You can also create logical switched interfaces for handling traffic with designated VLAN tags.
 
    [bookmark: pgfId-7203773]In a Layer 2 deployment, the system drops any traffic received on an external physical interface that does not have a switched interface waiting for it. If the system receives a packet with no VLAN tag and you have not configured a physical switched interface for that port, it drops the packet. If the system receives a VLAN-tagged packet and you have not configured a logical switched interface, it also drops the packet.
 
    [bookmark: pgfId-7204095]The system handles traffic that has been received with VLAN tags on switched interfaces by stripping the outermost VLAN tag on ingress before any rules evaluation or forwarding decisions. Packets leaving the device through a VLAN-tagged logical switched interface are encapsulated with the associated VLAN tag on egress.
 
    [bookmark: pgfId-7203687]Note that if you change the parent physical interface to inline or passive, the system deletes all the associated logical interfaces.
 
    [bookmark: pgfId-7188158]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7190152]Configuring Physical Switched Interfaces
 
     	 [bookmark: pgfId-7190156]Adding Logical Switched Interfaces
 
     	 [bookmark: pgfId-7190162]Deleting Logical Switched Interfaces
 
    
 
     
      [bookmark: pgfId-7190158]Configuring [bookmark: Configuring Physical Switched Interfaces]Physical Switc[bookmark: marker-7205034]hed Interfaces
 
     [bookmark: pgfId-7175197]License: Control
 
     [bookmark: pgfId-7222082]Supported Devices: Series 3
 
     [bookmark: pgfId-7244266]You can configure one or more physical ports on a managed device as switched interfaces. You must assign a physical switched interface to a virtual switch before it can handle traffic.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7244898] 
      Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
      How Snort Restarts Affect Traffic. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7244274]To configure a physical switched interface:
 
     [bookmark: pgfId-7225111]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7203627]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7175957]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7176032]The Interfaces tab appears.
 ). 
     
 
     [bookmark: pgfId-7176079]The Edit Interface pop-up window appears.
 
     [bookmark: pgfId-7176121]Step 4 Click Switched to display the switched interface options.
 
     [bookmark: pgfId-7180276]Step 5 Optionally, from the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
     [bookmark: pgfId-7180309]Step 6 Optionally, from the Virtual Switch drop-down list, select an existing virtual switch or select New to add a new virtual switch.
 
     [bookmark: pgfId-7180310]Note that if you add a new virtual switch, you must configure it on the Virtual Switches tab of the Device Management page (Devices > Device Management > Virtual Switches) after you set up the switched interface. See Adding Virtual Switches.
 
     [bookmark: pgfId-7176177]Step 7 Select the Enabled check box to allow the switched interface to handle traffic.
 
     [bookmark: pgfId-7186006]If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.
 
     [bookmark: pgfId-7227898]Step 8 From the Mode drop-down list, select an option to designate the link mode or select Autonegotiation to specify that the interface is configured to auto negotiate speed and duplex settings. Note that mode settings are available only for copper interfaces.
 
      
       
     
 
     
 
     [bookmark: pgfId-7227899]Note Interfaces on 8000 Series appliances do not support half-duplex options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7227900]Step 9 From the MDI/MDIX drop-down list, select an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX. Note that MDI/MDIX settings are available only for copper interfaces.
 
     [bookmark: pgfId-7186181]By default, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.
 
     [bookmark: pgfId-7181232]Step 10 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed.
 
     [bookmark: pgfId-7216512]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
     [bookmark: pgfId-7177793]Step 11 Click Save.
 
     [bookmark: pgfId-7197522]The physical switched interface is configured. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
     [bookmark: pgfId-7236976]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7197524]Adding [bookmark: Adding Logical Switched Interfaces]Logical Switc[bookmark: marker-7205048]hed Interfaces
 
     [bookmark: pgfId-7178694]License: Control
 
     [bookmark: pgfId-7222121]Supported Devices: Series 3
 
     [bookmark: pgfId-7178695]For each physical switched interface, you can add multiple logical switched interfaces. You must associate each logical interface with a VLAN tag to handle traffic received by the physical interface with that specific tag. You must assign a logical switched interface to a virtual switch to handle traffic.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7244918] 
      Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
      How Snort Restarts Affect Traffic. 
       
       
 
      
 
     
 ) next to the interface. 
     
 
     [bookmark: pgfId-7178698]To add a logical switched interface:
 
     [bookmark: pgfId-7178699]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7178700]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7178701]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7178703]The Interfaces tab appears.
 
     [bookmark: pgfId-7178704]Step 3 Click Add Interface.
 
     [bookmark: pgfId-7178705]The Add Interface pop-up window appears.
 
     [bookmark: pgfId-7178706]Step 4 Click Switched to display the switched interface options.
 
     [bookmark: pgfId-7178707]Step 5 From the Interface drop-down list, select the physical interface that will receive the VLAN-tagged traffic.
 
     [bookmark: pgfId-7178708]Step 6 In the VLAN Tag field, type a tag value that gets assigned to inbound and outbound traffic on this interface. The value can be any integer from 1 to 4094.
 
     [bookmark: pgfId-7178709]Step 7 Optionally, from the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
     [bookmark: pgfId-7178714]Step 8 Optionally, from the Virtual Switch drop-down list, select an existing virtual switch or select New to add a new virtual switch.
 
     [bookmark: pgfId-7201862]Note that if you add a new virtual switch, you must configure it on the Device Management page (Devices > Device Management> Virtual Switches) after you set up the switched interface. See Adding Virtual Switches.
 
     [bookmark: pgfId-7201869]Step 9 Select the Enabled check box to allow the switched interface to handle traffic.
 
     [bookmark: pgfId-7191425]If you clear the check box, the interface becomes disabled and administratively taken down. If you disable a physical interface, you also disable all of the logical interfaces associated with it.
 
     [bookmark: pgfId-7216730]Step 10 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed. 
 
     [bookmark: pgfId-7228857]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
     [bookmark: pgfId-7228864]Step 11 Click Save.
 
     [bookmark: pgfId-7228865]The logical switched interface is added. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-7243030]Note When a physical interface is disabled, the logical interface(s) associated with the physical interface is also disabled.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7237013]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7191429]Deleting [bookmark: Deleting Logical Switched Interfaces]Logical Switched Interfaces
 
     [bookmark: pgfId-7178728]License: Control
 
     [bookmark: pgfId-7222139]Supported Devices: Series 3
 
     [bookmark: pgfId-7178729]When you delete a logical switched interface, you remove it from the physical interface where it resides, as well as the virtual switch and security zone it is associated with.
 
     [bookmark: pgfId-7178730]To delete a switched interface:
 
     [bookmark: pgfId-7178731]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7189347]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7189348]The Device Management page appears.
 ) for that device. 
     
 
     [bookmark: pgfId-7189350]The Interfaces tab for that device appears.
 ). 
     
 
     [bookmark: pgfId-7199340]Step 4 When prompted, confirm that you want to delete the interface.
 
     [bookmark: pgfId-7191564]The interface is deleted. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
     [bookmark: pgfId-7237027]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7200788]Configuring [bookmark: Configuring Virtual Switches]Virtual Switc[bookmark: marker-7205058]hes
 
    [bookmark: pgfId-7200790]License: Control
 
    [bookmark: pgfId-7222159]Supported Devices: Series 3
 
    [bookmark: pgfId-7200791]Before you can use switched interfaces in a Layer 2 deployment, you must configure virtual switches and assign switched interfaces to them. A virtual switch is a group of switched interfaces that process inbound and outbound traffic through your network.
 
    [bookmark: pgfId-7190527]See the following sections for more information about configuring virtual switches:
 
     
     	 [bookmark: pgfId-7190531]Viewing Virtual Switches
 
     	 [bookmark: pgfId-7190537]Adding Virtual Switches
 
     	 [bookmark: pgfId-7190576]Configuring Advanced Virtual Switch Settings
 
     	 [bookmark: pgfId-7190597]Deleting Virtual Switches
 
    
 
     
      [bookmark: pgfId-7190533]Viewing [bookmark: Using the Virtual Switches Table View]Virtual Swit[bookmark: marker-7205063]ches
 
     [bookmark: pgfId-7187553]License: Control
 
     [bookmark: pgfId-7222179]Supported Devices: Series 3
 
      
       
        
        [bookmark: pgfId-7188168]Table 6-1 Virtual [bookmark: Virtual Switches Table View Fields]Switches Table View Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-7188172]Field 
          
  
         	 
           
           [bookmark: pgfId-7188174]Description 
          
  
        
 
         
         	[bookmark: pgfId-7188176]Name
  
         	[bookmark: pgfId-7188178]The name of the virtual switch.
  
        
 
         
         	[bookmark: pgfId-7188180]Interfaces
  
         	[bookmark: pgfId-7188182]All switched interfaces that are assigned to the virtual switch. Interfaces that you have disabled from the Interfaces tab are not available.
  
        
 
         
         	[bookmark: pgfId-7188184]Hybrid Interface
  
         	[bookmark: pgfId-7188186]The optionally configured hybrid interface that ties the virtual switch to a virtual router.
  
        
 
         
         	[bookmark: pgfId-7188188]Unicast Packets
  
         	[bookmark: pgfId-7188190]Unicast packet statistics for the virtual switch, including:
 
           
           	 [bookmark: pgfId-7188793]Unicast packets received
 
           	 [bookmark: pgfId-7188847]Unicast packets forwarded (excludes drops by host)
 
           	 [bookmark: pgfId-7188915]Unicast packets unintentionally dropped
 
          
  
        
 
         
         	[bookmark: pgfId-7188192]Broadcast Packets
  
         	[bookmark: pgfId-7188194]Broadcast packet statistics for the virtual switch, including:
 
           
           	 [bookmark: pgfId-7189049]Broadcast packets received
 
           	 [bookmark: pgfId-7189096]Broadcast packets forwarded
 
           	 [bookmark: pgfId-7189133]Broadcast packets unintentionally dropped
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7187953]Adding [bookmark: Adding Virtual Switches]Virtual Swit[bookmark: marker-7205074]ches
 
     [bookmark: pgfId-7174162]License: Control
 
     [bookmark: pgfId-7222195]Supported Devices: Series 3
 
     [bookmark: pgfId-7172735]You can add virtual switches from the Virtual Switches tab of the Device Management page. You can also add switches as you configure switched interfaces.
 
     [bookmark: pgfId-7197701]You can assign only switched interfaces to a virtual switch. If you want to create a virtual switch before you configure the switched interfaces on your managed devices, you can create an empty virtual switch and add interfaces to it later.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7174861]To add a virtual switch:
 
    [bookmark: pgfId-7174891]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7177315]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7177316]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7177318]The Interfaces tab appears.
 
    [bookmark: pgfId-7177319]Step 3 Click Virtual Switches.
 
    [bookmark: pgfId-7177320]The Virtual Switches tab appears.
 
    [bookmark: pgfId-7177321]Step 4 Click Add Virtual Switch.
 
    [bookmark: pgfId-7177480]The Add Virtual Switch pop-up window appears.
 
    [bookmark: pgfId-7177449]Step 5 In the Name field, type a name for the virtual switch. You can use alphanumeric characters and spaces.
 
    [bookmark: pgfId-7198008]Step 6 Under Available, select one or more switched interfaces to add to the virtual switch.
 
     
      
    
 
    
 
    [bookmark: pgfId-7226478]Tip Interfaces that you have disabled from the Interfaces tab are not available; disabling an interface after you add it removes it from the configuration.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7198010]Step 7 Click Add.
 
    [bookmark: pgfId-7197999]Step 8 Optionally, from the Hybrid Interface drop-down list, select a hybrid interface that ties the virtual switch to a virtual router. For more information, see Setting Up Hybrid Interfaces.
 
    [bookmark: pgfId-7198004]Step 9 Click Save.
 
    [bookmark: pgfId-7198005]The virtual switch is added. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-7192274]Tip To configure advanced settings for the switch, such as static MAC entries and spanning tree protocol, see Configuring Advanced Virtual Switch Settings.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7237033]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7178249]Configuring [bookmark: Configuring Advanced Virtual Switch Settings]Advanced Virtual Sw[bookmark: marker-7205083]itch Settings
 
    [bookmark: pgfId-7192504]License: Control
 
    [bookmark: pgfId-7222211]Supported Devices: Series 3
 
    [bookmark: pgfId-7192595]When adding or editing a virtual switch, you can add static MAC entries, enable Spanning Tree Protocol (STP), drop Bridge Protocol Data Units (BPDU), and enable strict TCP enforcement.
 
    [bookmark: pgfId-7194849]Over time, a virtual switch learns MAC addresses by tagging return traffic from the network. Optionally, you can manually add a static MAC entry, which designates that a MAC address resides on a specific port. Regardless of whether you ever receive traffic from that port, the MAC address remains static in the table. You can specify one or more static MAC addresses for each virtual switch.
 
    [bookmark: pgfId-7194850]STP is a network protocol used to prevent network loops. BPDUs are exchanged through the network, carrying information about network bridges. The protocol uses BPDUs to identify and select the fastest network links, if there are redundant links in the network. If a network link fails, Spanning Tree fails over to an existing alternate link.
 
    [bookmark: pgfId-7219429]If your virtual switch routes traffic between VLANs, similar to a router on a stick, BPDUs enter and exit the device through different logical switched interfaces, but the same physical switched interface. As a result, STP identifies the device as a redundant network loop, which can cause issues in certain Layer 2 deployments. To prevent this, you can configure the virtual switch at the domain level to have the device drop BPDUs when monitoring traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-7206828]Note Cisco strongly recommends that you enable STP when configuring a virtual switch that you plan to deploy in a device cluster.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7213444]To maximize TCP security, you can enable strict enforcement[bookmark: marker-7215101], which blocks connections where the three-way handshake was not completed. Strict enforcement also blocks:
 
     
     	 [bookmark: pgfId-7213737]non-SYN TCP packets for connections where the three-way handshake was not completed
 
     	 [bookmark: pgfId-7213759]non-SYN/RST packets from the initiator on a TCP connection before the responder sends the SYN-ACK
 
     	 [bookmark: pgfId-7213817]non-SYN-ACK/RST packets from the responder on a TCP connection after the SYN but before the session is established
 
     	 [bookmark: pgfId-7213832]SYN packets on an established TCP connection from either the initiator or the responder
 
    
 
    [bookmark: pgfId-7213852]Note that if you associate the virtual switch with a logical hybrid interface, the switch uses the same strict TCP enforcement setting as the virtual router associated with the logical hybrid interface. You cannot specify strict TCP enforcement on the switch in this case.
 
    [bookmark: pgfId-7184411]To configure advanced virtual switch settings:
 
    [bookmark: pgfId-7184482]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7190783]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7195633]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7195629]The Interfaces tab appears.
 
    [bookmark: pgfId-7195630]Step 3 Click Virtual Switches.
 
    [bookmark: pgfId-7190788]The Virtual Switches tab appears.
 ). 
    
 
    [bookmark: pgfId-7190790]The Edit Virtual Switch pop-up window appears.
 
    [bookmark: pgfId-7190791]Step 5 Click Advanced.
 
    [bookmark: pgfId-7194919]The Advanced tab appears.
 
    [bookmark: pgfId-7194947]Step 6 To add a static MAC entry, click Add.
 
    [bookmark: pgfId-7195022]The Add Static MAC Address pop-up window appears.
 
    [bookmark: pgfId-7227960]Step 7 In the MAC Address field, type the address using the standard format of six groups of two hexadecimal digits separated by colons (for example, 01:23:45:67:89:AB).
 
     
      
    
 
    
 
    [bookmark: pgfId-7227961]Note Broadcast addresses (00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF) cannot be added as static MAC addresses.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7194880]Step 8 From the Interface drop-down list, select the interface where you want to assign the MAC address.
 
    [bookmark: pgfId-7190825]Step 9 Click Add.
 
    [bookmark: pgfId-7195786]The MAC address is added to the Static MAC Entries table.
 ). 
    
 
    [bookmark: pgfId-7214134]Step 10 Optionally, to enable the Spanning Tree Protocol, select Enable Spanning Tree Protocol. Select Enable Spanning Tree Protocol only if your virtual switch switches traffic between multiple network interfaces.
 
    [bookmark: pgfId-7225821]You cannot select Drop BPDUs unless you clear Enable Spanning Tree Protocol.
 
    [bookmark: pgfId-7214135]Step 11 Optionally, select Strict TCP Enforcement to enable strict TCP enforcement.
 
    [bookmark: pgfId-7214136]If you associate the virtual switch with a logical hybrid interface, this option does not appear and the switch uses the same setting as the virtual router associated with the logical hybrid interface.
 
    [bookmark: pgfId-7219571]Step 12 Optionally, select Drop BPDUs to drop BPDUs at the domain level. Select Drop BPDUs only if your virtual switch routes traffic between VLANs on a single physical interface.
 
    [bookmark: pgfId-7225912]You cannot select Enable Spanning Tree Protocol unless you clear Drop BPDUs.
 
    [bookmark: pgfId-7213083]Step 13 Click Save.
 
    [bookmark: pgfId-7200606]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7237053]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7174810]Deleting [bookmark: Deleting Virtual Switches]Virtual Swi[bookmark: marker-7205092]tches
 
    [bookmark: pgfId-7198203]License: Control
 
    [bookmark: pgfId-7222227]Supported Devices: Series 3
 
    [bookmark: pgfId-7198204]When you delete a virtual switch, any switched interfaces assigned to the switch become available for inclusion in another switch.
 
    [bookmark: pgfId-7174391]To delete a virtual switch:
 
    [bookmark: pgfId-7196177]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7196180]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7195605]The Device Management page appears.
 ) for that device. 
    
 
    [bookmark: pgfId-7226197]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7196091]Step 3 Click Virtual Switches.
 
    [bookmark: pgfId-7196106]The Virtual Switches tab appears.
 ). 
    
 
    [bookmark: pgfId-7195609]Step 5 When prompted, confirm that you want to delete the virtual switch.
 
    [bookmark: pgfId-7195610]The virtual switch is deleted. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7237059]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7175030]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7349219][bookmark: 74990]Setting Up Virt[bookmark: marker-7349218]ual Routers 
      
      
 
     
 
 
    [bookmark: pgfId-6774604]You can configure a managed device in a Layer 3 deployment so that it routes traffic between two or more interfaces. You must assign an IP address to each interface and assign the interfaces to a virtual router to route traffic. On Series 3 managed devices, you can group multiple physical interfaces into a single logical routed interface called a link aggregation group (LAG). This single aggregate logical link provides higher bandwidth, redundancy, and load-balancing between two endpoints.
 
    [bookmark: pgfId-7198084]You can configure the system to route packets by making packet forwarding decisions according to the destination address. Interfaces configured as routed interfaces receive and forward the Layer 3 traffic. Routers obtain the destination from the outgoing interface based on the forwarding criteria, and access control rules designate the security policies to be applied.
 
    [bookmark: pgfId-7409873]In Layer 3 deployments, you can define static routes. In addition, you can configure Routing Information Protocol (RIP) and Open Shortest Path First (OSPF) dynamic routing protocols. You can also configure a combination of static routes and RIP or static routes and OSPF.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7409878] 
     Caution If a Layer 3 deployment fails for any reason, the device no longer passes traffic. 
      
      
 
     
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7424539] 
     Caution Adding a virtual router restarts the Snort process when you apply your changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7190411] See the following sections for more information about configuring a Layer 3 deployment:
 
     
     	 [bookmark: pgfId-7190484]Configuring Routed Interfaces
 
     	 [bookmark: pgfId-7190495]Configuring Virtual Routers
 
     	 [bookmark: pgfId-7403966]Configuring LAGs
 
    
 
   
 
    
     [bookmark: pgfId-7172744][bookmark: 86728]Configuring Routed Inter[bookmark: marker-7260326]faces
 
    [bookmark: pgfId-7375153]License: Control
 
    [bookmark: pgfId-7375157]Supported Devices: Series 3
 
    [bookmark: pgfId-7375158]You can set up routed interfaces with either physical or logical configurations. You can configure physical routed interface[bookmark: marker-7375159]s for handling untagged VLAN traffic. You can also create logical routed interfaces for handling traffic with designated VLAN tags.
 
    [bookmark: pgfId-7258638]In a Layer 3 deployment, the system drops any traffic received on an external physical interface that does not have a routed interface waiting for it. If the system receives a packet with no VLAN tag and you have not configured a physical routed interface for that port, it drops the packet. If the system receives a VLAN-tagged packet and you have not configured a logical routed interface, it also drops the packet.
 
    [bookmark: pgfId-7258684]The system handles traffic that has been received with VLAN tags on switched interfaces by stripping the outermost VLAN tag on ingress prior to any rules evaluation or forwarding decisions. Packets leaving the device through a VLAN-tagged logical routed interface are encapsulated with the associated VLAN tag on egress. The system drops any traffic received with a VLAN tag after the stripping process completes.
 
    [bookmark: pgfId-7257172]Note that if you change the parent physical interface to inline or passive, the system deletes all the associated logical interfaces.
 
    [bookmark: pgfId-7186071]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7190577]Configuring Physical Routed Interfaces
 
     	 [bookmark: pgfId-7190612]Adding Logical Routed Interfaces
 
     	 [bookmark: pgfId-7357889]Deleting Logical Routed Interfaces
 
     	 [bookmark: pgfId-7357890]Configuring SFRP
 
    
 
     
      [bookmark: pgfId-7357894][bookmark: 87239]Configuring Physical Routed Inte[bookmark: marker-7357893]rfaces
 
     [bookmark: pgfId-7357898]License: Control
 
     [bookmark: pgfId-7336162]Supported Devices: Series 3
 
     [bookmark: pgfId-7224205]You can configure one or more physical ports on a managed device as routed interfaces. You must assign a physical routed interface to a virtual router before it can route traffic.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7423924] 
      Caution Adding a routed interface pair on a Series 3 device restarts the Snort process when you apply your changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7224211]You can add static Address Resolution Protocol (ARP) entries to a routed interface. If an external host needs to know the MAC address of the destination IP address it needs to send traffic to on your local network, it sends an ARP request. When you configure static ARP entries, the virtual router responds with an IP address and associated MAC address.
 
     [bookmark: pgfId-7284150]Note that disabling the ICMP Enable Responses option for routed interfaces does not prevent ICMP responses in all scenarios. You can add rules to an access control policy to drop packets where the destination IP is the routed interface’s IP and the protocol is ICMP; see Controlling Traffic with Network-Based Rules.
 
     [bookmark: pgfId-7402499]If you have enabled the Inspect Local Router Traffic option on the managed device, it drops the packets before they reach the host, thereby preventing any response. For more information about inspecting local router traffic, see Understanding Advanced Device Settings.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7417300] 
      Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
      How Snort Restarts Affect Traffic. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7174476]To configure a physical routed interface:
 
     [bookmark: pgfId-7174515]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7183299]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7183300]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7183305]The Interfaces tab for that device appears.
 ). 
     
 
     [bookmark: pgfId-7183310]The Edit Interface pop-up window appears.
 
     [bookmark: pgfId-7183311]Step 4 Click Routed to display the routed interface options.
 
     [bookmark: pgfId-7183312]Step 5 Optionally, from the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
     [bookmark: pgfId-7183317]Step 6 Optionally, from the Virtual Router drop-down list, select an existing virtual router or select New to add a new virtual router.
 
     [bookmark: pgfId-7183318]Note that if you add a new virtual router, you must configure it on the Virtual Routers tab of the Device Management page (Devices > Device Management > Virtual Routers) after you set up the routed interface. See Adding Virtual Routers.
 
     [bookmark: pgfId-7183344]Step 7 Select the Enabled check box to allow the routed interface to handle traffic.
 
     [bookmark: pgfId-7183345]If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.
 
     [bookmark: pgfId-7183346]Step 8 From the Mode drop-down list, select an option to designate the link mode or select Autonegotiation to specify that the interface is configured to auto negotiate speed and duplex settings. Note that mode settings are available only for copper interfaces.
 
      
       
     
 
     
 
     [bookmark: pgfId-7355788]Note Interfaces on 8000 Series appliances do not support half-duplex options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7183347]Step 9 From the MDI/MDIX drop-down list, select an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX. Note that MDI/MDIX settings are available only for copper interfaces.
 
     [bookmark: pgfId-7183348]Normally, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.
 
     [bookmark: pgfId-7247003]Step 10 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed. Note that the MTU is the Layer 2 MTU/MRU and not the Layer 3 MTU.
 
     [bookmark: pgfId-7322054]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
     [bookmark: pgfId-7247001]Step 11 Next to ICMP, select the Enable Responses check box to allow the interface to respond to ICMP traffic such as pings and traceroute.
 
     [bookmark: pgfId-7184892]Step 12 Next to IPv6 NDP, select the Enable Router Advertisement check box to enable the interface to broadcast router advertisements.
 
     [bookmark: pgfId-7263850]Step 13 To add an IP address, click Add.
 
     [bookmark: pgfId-7263851]The Add IP Address pop-up window appears.
 
     [bookmark: pgfId-7263852]Step 14 In the Address field, type the routed interface’s IP address and subnet mask using CIDR notation. Note the following:
 
      
       
       	 [bookmark: pgfId-7356142]You cannot add network and broadcast addresses, or the static MAC addresses 00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF.
 
       	 [bookmark: pgfId-7356167]You cannot add identical IP addresses, regardless of subnet mask, to interfaces in virtual routers.
 
      
 
     
 
     [bookmark: pgfId-7186662]Step 15 Optionally, if your organization uses IPv6 addresses, next to the IPv6 field, select the Address Autoconfiguration check box to set the IP address of the interface automatically.
 
     [bookmark: pgfId-7186796]Step 16 For Type, select either Normal or SFRP. 
 
     [bookmark: pgfId-7285548]For SFRP options, see Configuring SFRP for more information.
 
     [bookmark: pgfId-7245415]Step 17 Click OK.
 
     [bookmark: pgfId-7245416]The IP address is added.
 ). 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7245778]Note When adding an IP address to a routed interface of a clustered device, you must add a corresponding IP address to the routed interface on the cluster peer.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7185046]Step 18 To add a static ARP entry, click Add.
 
     [bookmark: pgfId-7267417]The Add Static ARP Entry pop-up window appears.
 
     [bookmark: pgfId-7267422]Step 19 In the IP Address field, type an IP address for the static ARP entry.
 
     [bookmark: pgfId-7267413]Step 20 In the MAC Address field, type a MAC address to associate with the IP address. Enter the address using the standard format of six groups of two hexadecimal digits separated by colons (for example, 01:23:45:67:89:AB).
 
     [bookmark: pgfId-7191289]Step 21 Click OK.
 
     [bookmark: pgfId-7191314]The static ARP entry is added.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7184986]Step 22 Click Save.
 
    [bookmark: pgfId-7185698]The physical routed interface is configured. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7388314]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7185699][bookmark: 19983]Adding Logical Routed Int[bookmark: marker-7260354]erfaces
 
    [bookmark: pgfId-7185745]License: Control
 
    [bookmark: pgfId-7336178]Supported Devices: Series 3
 
    [bookmark: pgfId-7424172]For each physical routed interface, you can add multiple logical routed interfaces. You must associate each logical interface with a VLAN tag to handle traffic received by the physical interface with that specific tag. You must assign a logical routed interface to a virtual router to route traffic.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7424196] 
     Caution Adding a routed interface pair on a Series 3 device restarts the Snort process when you apply your changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7424173]Note that disabling the ICMP Enable Responses option for routed interfaces does not prevent ICMP responses in all scenarios. You can add rules to an access control policy to drop packets where the destination IP is the routed interface’s IP and the protocol is ICMP; see Controlling Traffic with Network-Based Rules. 
 
    [bookmark: pgfId-7402525]If you have enabled the Inspect Local Router Traffic option on the managed device, it drops the packets before they reach the host, thereby preventing any response. For more information about inspecting local router traffic, see Understanding Advanced Device Settings.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7417332] 
     Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 ) next to the interface. 
    
 
    [bookmark: pgfId-7374041]To add a logical routed interface:
 
    [bookmark: pgfId-7374042]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7374043]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7191424]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7191429]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7191430]Step 3 Click Add Interface.
 
    [bookmark: pgfId-7191592]The Add Interface pop-up window appears.
 
    [bookmark: pgfId-7191593]Step 4 Click Routed to display the routed interface options.
 
    [bookmark: pgfId-7191594]Step 5 From the Interface drop-down list, select the physical interface where you want to add the logical interface.
 
    [bookmark: pgfId-7250239]Step 6 In the VLAN Tag field, type a tag value that gets assigned to inbound and outbound traffic on this interface. The value can be any integer from 1 to 4094.
 
    [bookmark: pgfId-7250240]Step 7 Optionally, from the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
    [bookmark: pgfId-7191641]Step 8 Optionally, from the Virtual Router drop-down list, select an existing virtual router or select New to add a new virtual router.
 
    [bookmark: pgfId-7191642]Note that if you add a new virtual router, you must configure it on the Device Management page (Devices > Device Management > Virtual Routers) after you finish setting up the routed interface. See Adding Virtual Routers.
 
    [bookmark: pgfId-7191646]Step 9 Select the Enabled check box to allow the routed interface to handle traffic.
 
    [bookmark: pgfId-7191647]If you clear the check box, the interface becomes disabled and administratively taken down. If you disable a physical interface, you also disable all of the logical interfaces associated with it.
 
    [bookmark: pgfId-7191667]Step 10 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed. Note that the MTU is the Layer 2 MTU/MRU and not the Layer 3 MTU.
 
    [bookmark: pgfId-7358051]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
    [bookmark: pgfId-7358058]Step 11 Next to ICMP, select the Enable Responses check box to communicate updates or error information to other routers, intermediary devices, or hosts.
 
    [bookmark: pgfId-7191961]Step 12 Next to IPv6 NDP, select the Enable Router Advertisement check box to enable the interface to broadcast router advertisements.
 
    [bookmark: pgfId-7191962]Step 13 To add an IP address, click Add.
 
    [bookmark: pgfId-7191963]The Add IP Address pop-up window appears.
 
    [bookmark: pgfId-7191964]Step 14 In the Address field, type the IP address in CIDR notation. Note the following:
 
     
      
      	 [bookmark: pgfId-7356215]You cannot add network and broadcast addresses, or the static MAC addresses 00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF.
 
      	 [bookmark: pgfId-7356216]You cannot add identical IP addresses, regardless of subnet mask, to interfaces in virtual routers.
 
     
 
    
 
    [bookmark: pgfId-7191965]Step 15 Optionally, if your organization uses IPv6 addresses, next to the IPv6 field, select the Address Autoconfiguration check box to set the IP address of the interface automatically.
 
    [bookmark: pgfId-7191966]Step 16 For Type, select either Normal or SFRP. 
 
    [bookmark: pgfId-7286059]For SFRP options, see Configuring SFRP for more information.
 
    [bookmark: pgfId-7191970]Step 17 Click OK.
 
    [bookmark: pgfId-7191971]The IP address is added.
 ). 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7245655]Note When you[bookmark: marker-7260373] add an IP address to a routed interface of a clustered device, you must add a corresponding IP address to the routed interface on the cluster peer.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7191973]Step 18 To add a static ARP entry, click Add.
 
    [bookmark: pgfId-7191974]The Add Static ARP Entry pop-up window appears.
 
    [bookmark: pgfId-7191975]Step 19 In the IP Address field, type an IP address for the static ARP entry.
 
    [bookmark: pgfId-7191976]Step 20 In the MAC Address field, type a MAC address to associate with the IP address. Enter the address using the standard format of six groups of two hexadecimal digits separated by colons (for example, 01:23:45:67:89:AB).
 
    [bookmark: pgfId-7191977]Step 21 Click OK.
 
    [bookmark: pgfId-7191978]The static ARP entry is added.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7191513]Step 22 Click Save.
 
   [bookmark: pgfId-7191514]The logical routed interface is added. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    
     
   
 
   
 
   [bookmark: pgfId-7409794]Note When a physical interface is disabled, the logical interface(s) associated with the physical interface is also disabled.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-7388359]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7185708][bookmark: 68587]Deleting Logical Routed Interfaces
 
    [bookmark: pgfId-7185700]License: Control
 
    [bookmark: pgfId-7336200]Supported Devices: Series 3
 
    [bookmark: pgfId-7174273]When you delete a logical routed interface, you remove it from the physical interface where it resides, as well as its assigned virtual router and security zone.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7424220] 
     Caution Adding a routed interface pair on a Series 3 device restarts the Snort process when you apply your changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7174283]To delete a routed interface:
 
    [bookmark: pgfId-7174753]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7190144]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7190145]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7190150]The Interfaces tab for that device appears.
 ). 
    
 
    [bookmark: pgfId-7190155]Step 4 When prompted, confirm that you want to delete the interface.
 
    [bookmark: pgfId-7190156]The interface is deleted. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7388474]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7192384][bookmark: 52595]Configuring SFRP
 
    [bookmark: pgfId-7192443]License: Control
 
    [bookmark: pgfId-7336216]Supported Devices: Series 3
 
    [bookmark: pgfId-7192465]You can configure Cisco Redundancy Protocol [bookmark: marker-7260441](SFRP) to achieve network redundancy for high availability on either a device cluster or individual devices. SFRP provides gateway redundancy for both IPv4 and IPv6 addresses. You can configure SFRP on routed and hybrid interfaces.
 
    [bookmark: pgfId-7244770]If the interfaces are configured on individual devices, they must be in the same broadcast domain. You must designate at least one of the interfaces as master and an equal number as backup. The system supports only one master and one backup per IP address. If network connectivity is lost, the system automatically promotes the backup to master to maintain connectivity.
 
    [bookmark: pgfId-7255005]The options you set for SFRP must be the same on all interfaces in a group of SFRP interfaces. Multiple IP addresses in a group must be in the same master/backup state. Therefore, when you add or edit an IP address, the state you set for that address propagates to all the addresses in the group. For security purposes, you must enter values for Group ID and Shared Secret that are shared among the interfaces in the group.
 
    [bookmark: pgfId-7259179]To enable SFRP IP addresses on a virtual router, you must also configure at least one non-SFRP IP address.
 
    [bookmark: pgfId-7413469]For clustered devices, you designate the shared secret and the system copies it to the cluster peer along with the SFRP IP configuration. The shared secret authenticates peer data.
 
     
      
    
 
    
 
    [bookmark: pgfId-7414026]Note Cisco does not recommend enabling more than one non-SFRP IP address on a clustered Series 3 device’s routed or hybrid interface where one SFRP IP address is already configured.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7254997]For more information about clustering devices, see Clustering Devices.
 
    [bookmark: pgfId-7254999]To configure SFRP:
 
    [bookmark: pgfId-7242172]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7242207]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7242208]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7242213]The Interfaces tab for that device appears.
 ). 
    
 
    [bookmark: pgfId-7242218]The Edit Interface pop-up window appears.
 
    [bookmark: pgfId-7242281]Step 4 Select the type of interface where you want to configure SFRP:
 
     
      
      	 [bookmark: pgfId-7242395]Click  Routed  to display the routed interface options.
 
      	 [bookmark: pgfId-7242439]Click  Hybrid to display the hybrid interface options.
 
     
 
    
 
    [bookmark: pgfId-7242526]Step 5 You can configure SFRP while adding or editing an IP address:
 
     
      
      	 [bookmark: pgfId-7242827]To add an IP address, click  Add .
 
      	 [bookmark: pgfId-7242883]To edit an IP address, click the edit icon (
 
     
 
     [image: ] ). 
    
 
    [bookmark: pgfId-7242948]The Add IP Address or Edit IP Address pop-up window appears.
 
    [bookmark: pgfId-7243017]Step 6 For Type, select SFRP to display the SFRP options.
 
    [bookmark: pgfId-7243083]Step 7 In the Group ID field, enter a value that designates a group of master or backup interfaces configured for SFRP.
 
    [bookmark: pgfId-7244458]Step 8 For Priority, select either Master or Backup to designate the preferred interface:
 
     
      
      	 [bookmark: pgfId-7244459]For individual devices, you must set one interface to master on one device and the other to backup on a second device.
 
      	 [bookmark: pgfId-7244322]For device clusters, when you set one interface as master, the other automatically becomes the backup.
 
     
 
    
 
    [bookmark: pgfId-7243388]Step 9 In the Shared Secret field, type a shared secret.
 
    [bookmark: pgfId-7243432]The Shared Secret field populates automatically for a group in a device cluster.
 
    [bookmark: pgfId-7243439]Step 10 In the Adv. Interval (seconds) field, enter an interval for route advertisements for Layer 3 traffic.
 
    [bookmark: pgfId-7243500]Step 11 Click OK.
 
    [bookmark: pgfId-7243521]The IP address is added or edited.
 
    [bookmark: pgfId-7243523]Step 12 Click Save.
 
    [bookmark: pgfId-7244566]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7388489]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7241274][bookmark: 70599]Confi[bookmark: marker-7260382]guring Virtual Routers
 
    [bookmark: pgfId-7244627]License: Control
 
    [bookmark: pgfId-7336232]Supported Devices: Series 3
 
    [bookmark: pgfId-7244628]Before you can use routed interfaces in a Layer 3 deployment, you must configure virtual routers and assign routed interfaces to them. A virtual router is a group of routed interfaces that route Layer 3 traffic.
 
    [bookmark: pgfId-7185262]See the following sections for more information about configuring virtual routers:
 
     
     	 [bookmark: pgfId-7185263]Viewing Virtual Routers
 
     	 [bookmark: pgfId-7185264]Adding Virtual Routers
 
     	 [bookmark: pgfId-7199493]Viewing Virtual Router Statistics
 
     	 [bookmark: pgfId-7199516]Deleting Virtual Routers
 
    
 
     
      [bookmark: pgfId-7199407]Viewing [bookmark: Using the Virtual Routers Table View]Virtual Rou[bookmark: marker-7260387]ters
 
     [bookmark: pgfId-7185292]License: Control
 
     [bookmark: pgfId-7336248]Supported Devices: Series 3
 
      
       
        
        [bookmark: pgfId-7190225]Table 7-1 Virtual [bookmark: Virtual Switches Table View Fields]Routers Table View Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-7190229]Field 
          
  
         	 
           
           [bookmark: pgfId-7190231]Description 
          
  
        
 
         
         	[bookmark: pgfId-7190233]Name
  
         	[bookmark: pgfId-7190235]The name of the virtual router.
  
        
 
         
         	[bookmark: pgfId-7190237]Interfaces
  
         	[bookmark: pgfId-7190239]A list of all routed interfaces that are assigned to the virtual router. Disabling an interface from the Interfaces tab removes it.
  
        
 
         
         	[bookmark: pgfId-7190241]Protocols
  
         	[bookmark: pgfId-7247362]The protocols currently in use by the virtual router, which is one of the following:
 
           
           	 [bookmark: pgfId-7247363]Static
 
           	 [bookmark: pgfId-7192162]Static, RIP
 
           	 [bookmark: pgfId-7192175]Static, OSPF
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7172748][bookmark: 37574]Adding [bookmark: marker-7184873]Virtual Routers
 
     [bookmark: pgfId-7241415]License: Control
 
     [bookmark: pgfId-7336264]Supported Devices: Series 3
 
     [bookmark: pgfId-7190803]You can add virtual routers from the Virtual Routers tab of the Device Management page. You can also add routers as you configure routed interfaces.
 
     [bookmark: pgfId-7190804]You can assign only routed and hybrid interfaces to a virtual router. If you want to create a virtual router before you configure the interfaces on your managed devices, you can create an empty virtual router and add interfaces to it later.
 
     [bookmark: pgfId-7306876]To maximize TCP security, you can enable strict enforcement[bookmark: marker-7311886], which blocks connections where the three-way handshake was not completed. Strict enforcement also blocks:
 
      
      	 [bookmark: pgfId-7306877]non-SYN TCP packets for connections where the three-way handshake was not completed
 
      	 [bookmark: pgfId-7306878]non-SYN/RST packets from the initiator on a TCP connection before the responder sends the SYN-ACK
 
      	 [bookmark: pgfId-7306879]non-SYN-ACK/RST packets from the responder on a TCP connection after the SYN but before the session is established
 
      	 [bookmark: pgfId-7306998]SYN packets on an established TCP connection from either the initiator or the responder
 
     
 
     [bookmark: pgfId-7255738]Note that if you change the configuration of a Layer 3 interface to a non-Layer 3 interface or remove a Layer 3 interface from the virtual router, the router may fall into an invalid state. For example, if it is used in DHCPv6, it may cause an upstream and downstream mismatch. Any changes you make to an existing virtual router may interrupt traffic on the device.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7192639]You can configure virtual routers in several different ways beyond the general options. See the following sections for more information about these configurations:
 
     
     	 [bookmark: pgfId-7192783]Setting Up DHCP Relay
 
     	 [bookmark: pgfId-7192797]Setting Up Static Routes
 
     	 [bookmark: pgfId-7192804]Setting Up Dynamic Routing
 
     	 [bookmark: pgfId-7192810]Setting Up RIP Configuration
 
     	 [bookmark: pgfId-7192816]Setting Up OSPF Configuration
 
     	 [bookmark: pgfId-7192876]Setting Up Virtual Router Filters
 
     	 [bookmark: pgfId-7192895]Adding Virtual Router Authentication Profiles
 
    
 
    [bookmark: pgfId-7190720]To add a virtual router:
 
    [bookmark: pgfId-7187374]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7187375]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7187376]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7187428]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7345306]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7345307]The Virtual Routers tab appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-7187519]Tip If your devices are in a clustered stack deployment, select the stack you want to modify from the Selected Device drop-down list.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7345321]Step 4 Click Add Virtual Router.
 
    [bookmark: pgfId-7187520]The Add Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7355026]Step 5 In the Name field, type a name for the virtual router. You can use alphanumeric characters and spaces.
 
    [bookmark: pgfId-7355027]Step 6 To enable IPv6 static routing, OSPFv3, and RIPng on your virtual router, select the IPv6 Support check box. To disable these features, clear the check box.
 
    [bookmark: pgfId-7355029]Step 7 Optionally, clear Strict TCP Enforcement if you do not want to enable strict TCP enforcement. 
 
    [bookmark: pgfId-7307108]This option is enabled by default.
 
    [bookmark: pgfId-7187545]Step 8 Under Interfaces, the Available list contains all enabled Layer 3 interfaces, routed and hybrid, on the device that you can assign to the virtual router. Select one or more interfaces to assign to the virtual router and click Add.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7187561]Step 9 Click Save.
 
   [bookmark: pgfId-7187562]The virtual router is added. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7388510]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7172754][bookmark: 31023]Setting Up DH[bookmark: marker-7260398]CP Relay
 
    [bookmark: pgfId-7336292]License: Control
 
    [bookmark: pgfId-7336303]Supported Devices: Series 3
 
    [bookmark: pgfId-7336294]DHCP provides configuration parameters to Internet hosts. A DHCP client that has not yet acquired an IP address cannot communicate directly with a DHCP server outside its broadcast domain. To allow DHCP clients to communicate with DHCP servers, you can configure DHCP relay instances to handle cases where the client is not on the same broadcast domain as the server.
 
    [bookmark: pgfId-7220599]You can set up DHCP relay for each virtual router you configure. By default, this feature is disabled. You can enable either DHCPv4 relay or DHCPv6 relay.
 
    [bookmark: pgfId-7194682]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7194733]Setting Up DHCPv4 Relay
 
     	 [bookmark: pgfId-7194738]Setting Up DHCPv6 Relay
 
    
 
   
 
    
     [bookmark: pgfId-7194460][bookmark: 95657]Setting Up DHCPv4 R[bookmark: marker-7260403]elay
 
    [bookmark: pgfId-7194760]License: Control
 
    [bookmark: pgfId-7336319]Supported Devices: Series 3
 
    [bookmark: pgfId-7194770]The following procedure explains how to set up DHCPv4 relay on a virtual router.
 
    [bookmark: pgfId-7175684]To set up DHCPv4 relay:
 
    [bookmark: pgfId-7175711]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7193528]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7193529]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7193534]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7193535]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7193536]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7193538]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7193539]Step 5 To set up DHCP relay for DHCPv4, select the DHCPv4 check box.
 
    [bookmark: pgfId-7193977]Step 6 Under the Servers field, type a server IP address.
 
    [bookmark: pgfId-7194063]Step 7 Click Add.
 
    [bookmark: pgfId-7194080]The IP address is added to the Servers field. You can add up to four DHCP servers.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7194325]Step 8 In the Max Hops field, type the maximum number of hops from 1 to 255.
 
   [bookmark: pgfId-7192362]Step 9 Click Save.
 
   [bookmark: pgfId-7192363]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7388529]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7194876][bookmark: 21973]Setting Up DHCPv6 R[bookmark: marker-7260408]elay
 
    [bookmark: pgfId-7194877]License: Control
 
    [bookmark: pgfId-7336337]Supported Devices: Series 3
 
    [bookmark: pgfId-7194878]The following procedure explains how to set up DHCPv6 relay on a virtual router.
 
     
      
    
 
    
 
    [bookmark: pgfId-7350968]Note You cannot run a DHCPv6 Relay chain through two or more virtual routers running on the same device.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7194879]To set up DHCPv6 relay:
 
    [bookmark: pgfId-7194880]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7194881]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7194882]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7194887]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7194888]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7194889]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7194891]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7194892]Step 5 To set up DHCP relay for DHCPv6, select the DHCPv6 check box.
 
    [bookmark: pgfId-7350570]Step 6 In the Interfaces field, select the check boxes next to one or more interfaces that have been assigned to the virtual router.
 
     
      
    
 
    
 
    [bookmark: pgfId-7350571]Tip You cannot disable an interface from the Interfaces tab while it is configured for DHCPv6 Relay. You must first clear the DHCPv6 Relay interfaces check box and save the configuration.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7350572]Step 7 Next to a selected interface, click the drop-down icon and select whether the interface relays DHCP requests Upstream, Downstream, or Both.
 
    [bookmark: pgfId-7195333]Note that you must include at least one downstream interface and one upstream interface. Selecting both means that the interface is both downstream and upstream.
 
    [bookmark: pgfId-7194900]Step 8 In the Max Hops field, type the maximum number of hops from 1 to 255
 
    [bookmark: pgfId-7194901]Step 9 Click Save.
 
    [bookmark: pgfId-7194902]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7388596]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7192364][bookmark: 63428]Setting Up Sta[bookmark: marker-7260417]tic Routes
 
    [bookmark: pgfId-7336373]License: Control
 
    [bookmark: pgfId-7336388]Supported Devices: Series 3
 
    [bookmark: pgfId-7336375]Static routing allows you to write rules about the IP addresses of traffic passing through a router. It is the simplest way of configuring path selection of a virtual router because there is no communication with other routers regarding the current topology of the network.
 
    [bookmark: pgfId-7195510]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7200100]Understanding the Static Routes Table View
 
     	 [bookmark: pgfId-7200699]Adding Static Routes
 
    
 
   
 
    
     [bookmark: pgfId-7200705][bookmark: 92522]Understanding the St[bookmark: marker-7260431]atic Routes Table View
 
    [bookmark: pgfId-7200083]License: Control
 
    [bookmark: pgfId-7336408]Supported Devices: Series 3
 
     
      
       
       [bookmark: pgfId-7195838]Table 7-2 Static Routes Table View Fields 
 
       
       
        
        	 
          
          [bookmark: pgfId-7195842]Field 
         
  
        	 
          
          [bookmark: pgfId-7195844]Description 
         
  
       
 
        
        	[bookmark: pgfId-7195846]Enabled
  
        	[bookmark: pgfId-7195848]Specifies whether this route is currently enabled or disabled.
  
       
 
        
        	[bookmark: pgfId-7195850]Name
  
        	[bookmark: pgfId-7195852]The name of the static route.
  
       
 
        
        	[bookmark: pgfId-7195854]Destination
  
        	[bookmark: pgfId-7195856]The destination network where traffic is routed.
  
       
 
        
        	[bookmark: pgfId-7195858]Type
  
        	[bookmark: pgfId-7277804]Specifies the action that is taken for this route, which will is one of the following:
 
          
          	 [bookmark: pgfId-7277805]IP — designates that the route forwards packets to the address of a neighboring router.
 
          	 [bookmark: pgfId-7195957]Interface — designates that the route forwards packets to an interface through which traffic is routed to hosts on a directly connected network.
 
          	 [bookmark: pgfId-7196069]Discard — designates that the static route drops packets.
 
         
  
       
 
        
        	[bookmark: pgfId-7195882]Gateway
  
        	[bookmark: pgfId-7195884]The target IP address if you selected IP as the static route type or the interface if you selected Interface as the static route type.
  
       
 
        
        	[bookmark: pgfId-7196127]Preference
  
        	[bookmark: pgfId-7196129]Determines the route selection. If you have multiple routes to the same destination, the system selects the route with the higher preference.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-7172760][bookmark: 80205]Adding Static Ro[bookmark: marker-7260436]utes
 
    [bookmark: pgfId-7175406]License: Control
 
    [bookmark: pgfId-7336427]Supported Devices: Series 3
 
    [bookmark: pgfId-7172761]The following procedure explains how to add a static route.
 ). 
    
 
    [bookmark: pgfId-7175832]To add a static route:
 
    [bookmark: pgfId-7175871]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7188193]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7188194]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7188199]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7188200]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7188201]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7188467]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7188202]Step 5 Click Static to display the static route options.
 
    [bookmark: pgfId-7188543]Step 6 Click Add Static Route.
 
    [bookmark: pgfId-7188569]The Add Static Route pop-up window appears.
 
    [bookmark: pgfId-7188204]Step 7 In the Route Name field, type a name for the static route. You can use alphanumeric characters and spaces.
 
    [bookmark: pgfId-7188645]Step 8 For Enabled, select the check box to specify that the route is currently enabled.
 
    [bookmark: pgfId-7188719]Step 9 In the Preference field, type a numerical value between 1 and 65535 to determine the route selection.
 
    [bookmark: pgfId-7304424]If you have multiple routes to the same destination, the system selects the route with the higher preference.
 
    [bookmark: pgfId-7188767]Step 10 From the Type drop-down list, select the type of static route you are configuring.
 
    [bookmark: pgfId-7188817]Step 11 In the Destination field, type the IP address for the destination network where traffic should be routed.
 
    [bookmark: pgfId-7188907]Step 12 In the Gateway field, you have two options:
 
     
      
      	 [bookmark: pgfId-7256929]If you selected  IP as the selected static route type, type an IP address.
 
      	 [bookmark: pgfId-7256962]If you selected  Interface as the selected static route type, select an enabled interface from the drop-down list.
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7349973]Tip Interfaces you have disabled from the Interfaces tab are not available; disabling an interface you have added removes it from the configuration.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7188233]Step 13 Click OK.
 
    [bookmark: pgfId-7200621]The static route is added.
 
    [bookmark: pgfId-7200623]Step 14 Click Save.
 
    [bookmark: pgfId-7200548]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7388661]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7196377][bookmark: 15160][bookmark: 65618]Setting Up Dyna[bookmark: marker-7260464]mic Routing
 
    [bookmark: pgfId-7176045]License: Control
 
    [bookmark: pgfId-7336447]Supported Devices: Series 3
 
    [bookmark: pgfId-7176048]Dynamic, or adaptive, routing uses a routing protocol to alter the path that a route takes in response to a change in network conditions. The adaptation is intended to allow as many routes as possible to remain valid, that is, have destinations that can be reached in response to the change. This allows the network to “route around” damage, such as loss of a node or a connection between nodes, so long as other path choices are available. You can configure a router with no dynamic routing, or you can configure the Routing Information Protocol (RIP) or the Open Shortest Path First (OSPF) routing protocol.
 
    [bookmark: pgfId-7196605]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7201426]Setting Up RIP Configuration
 
     	 [bookmark: pgfId-7196960]Setting Up OSPF Configuration
 
    
 
   
 
    
     [bookmark: pgfId-7196608][bookmark: 79233]Setting Up RIP Conf[bookmark: marker-7260469]iguration
 
    [bookmark: pgfId-7176673]License: Control
 
    [bookmark: pgfId-7336496]Supported Devices: Series 3
 
    [bookmark: pgfId-7336497]Routing Information Protocol (RIP) is a dynamic routing protocol, designed for small IP networks, that relies on hop count to determine routes. The best routes use the fewest number of hops. The maximum number of hops allowed for RIP is 15. This hop limit also limits the size of the network that RIP can support.
 
    [bookmark: pgfId-7201655]See the following sections for more information on configuring RIP:
 
     
     	 [bookmark: pgfId-7201732]Adding Interfaces for RIP Configuration
 
     	 [bookmark: pgfId-7201741]Configuring Authentication Settings for RIP Configuration
 
     	 [bookmark: pgfId-7201747]Configuring Advanced Settings for RIP Configuration
 
     	 [bookmark: pgfId-7201757]Adding Import Filters for RIP Configuration
 
     	 [bookmark: pgfId-7202343]Adding Export Filters for RIP Configuration
 
    
 
   
 
    
     [bookmark: pgfId-7175503][bookmark: 41455]Adding Interfaces for RIP Config[bookmark: marker-7260474]uration
 
    [bookmark: pgfId-7176850]License: Control
 
    [bookmark: pgfId-7336507]Supported Devices: Series 3
 
    [bookmark: pgfId-7202057]While configuring RIP, you must select interfaces from those already included in the virtual router, where you want to configure RIP. Disabled interfaces are not available.
 ). 
    
 
    [bookmark: pgfId-7202059]To add an interface for RIP configuration:
 
    [bookmark: pgfId-7176921]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7201609]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7201610]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7201615]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7201616]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7201617]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7201622]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7201945]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7201946]Step 6 Click RIP to display the RIP options.
 ). 
    
 
    [bookmark: pgfId-7201626]The Add an Interface pop-up window appears.
 
    [bookmark: pgfId-7201984]Step 8 From the Name drop-down list, select the interface where you want to configure RIP. 
 
     
      
    
 
    
 
    [bookmark: pgfId-7350063]Tip Interfaces you have disabled from the Interfaces tab are not available; disabling an interface you have added removes it from the configuration.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7202485]Step 9 In the Metric field, type a metric for the interface. When routes from different RIP instances are available and all of them have the same preference, the route with the lowest metric becomes the preferred route.
 
    [bookmark: pgfId-7202549]Step 10 From the Mode drop-down list, select one of the following options:
 
     
      
      	 [bookmark: pgfId-7202625] Multicast — default mode where RIP multicasts the entire routing table to all adjacent routers at a specified address.
 
      	 [bookmark: pgfId-7202743] Broadcast — forces RIP to use broadcast (for example, RIPv1) even though multicast mode is possible.
 
      	 [bookmark: pgfId-7202758] Quiet — RIP will not transmit any periodic messages to this interface.
 
      	 [bookmark: pgfId-7202773] No Listen — RIP will send to this interface but not listen to it.
 
     
 
    
 
    [bookmark: pgfId-7202835]Step 11 Click Save.
 
    [bookmark: pgfId-7202827]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7388698]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7172775][bookmark: 57624]Configuring Authentication Sett[bookmark: marker-7260486]ings for RIP Configuration
 
    [bookmark: pgfId-7177732]License: Control
 
    [bookmark: pgfId-7336523]Supported Devices: Series 3
 
    [bookmark: pgfId-7177741]RIP authentication uses one of the authentication profiles you configured on the virtual router. For more information about configuring authentication profiles, see Adding Virtual Router Authentication Profiles.
 
    [bookmark: pgfId-7172776]To configure authentication settings for RIP configuration:
 
    [bookmark: pgfId-7203086]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7203087]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7203088]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7203093]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7203094]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7203095]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7203100]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7203101]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7203102]Step 6 Click RIP to display the RIP options.
 
    [bookmark: pgfId-7203106]Step 7 Under Authentication, use the Profile drop-down list to select an existing virtual router authentication profile or select None. 
 
    [bookmark: pgfId-7203115]Step 8 Click Save.
 
    [bookmark: pgfId-7203648]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7388766]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7172777][bookmark: 77659]Configuring Advanc[bookmark: marker-7260491]ed Settings for RIP Configuration
 
    [bookmark: pgfId-7177962]License: Control
 
    [bookmark: pgfId-7336539]Supported Devices: Series 3
 
    [bookmark: pgfId-7177973]You can configure several advanced RIP settings pertaining to various timeout values and other features that affect the behavior of the protocol.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7258297] 
     Caution Changing any of the advanced RIP settings to incorrect values can prevent the router from communicating successfully with other RIP routers. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7172778]To configure advanced settings for RIP configuration:
 
    [bookmark: pgfId-7203183]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7203184]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7203185]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7203190]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7203191]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7203192]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7203197]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7203198]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7204284]Step 6 Click RIP to display the RIP options.
 
    [bookmark: pgfId-7204288]Step 7 In the Preference field, type a numerical value (higher is better) for the preference of the routing protocol. The system prefers routes learned through RIP over static routes.
 
    [bookmark: pgfId-7206787]Step 8 In the Period field, type the interval, in seconds, between periodic updates. A lower number determines faster convergence, but larger network load.
 
    [bookmark: pgfId-7206823]Step 9 In the Timeout Time field, type a numerical value that specifies how old routes must be, in seconds, before being considered unreachable.
 
    [bookmark: pgfId-7206878]Step 10 In the Garbage Time field, type a numerical value that specifies how old routes must be, in seconds, before being discarded.
 
    [bookmark: pgfId-7206917]Step 11 In the Infinity field, type a numerical value that specifies a value for infinity distance in convergence calculations. Larger values will make protocol convergence slower.
 
    [bookmark: pgfId-7206956]Step 12 From the Honor drop-down list, select one of the following options to designate when requests for dumping routing tables should be honored:
 
     
      
      	 [bookmark: pgfId-7219933] Always — always honor requests
 
      	 [bookmark: pgfId-7219948] Neighbor — only honor requests sent from a host on a directly connected network
 
      	 [bookmark: pgfId-7219951] Never — never honor requests
 
     
 
    
 
    [bookmark: pgfId-7204281]Step 13 Click Save.
 
    [bookmark: pgfId-7203680]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7388787]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7172779][bookmark: 54014]Adding Import Filters for RIP C[bookmark: marker-7260511]onfiguration
 
    [bookmark: pgfId-7178083]License: Control
 
    [bookmark: pgfId-7336555]Supported Devices: Series 3
 
    [bookmark: pgfId-7202262]You can add an import filter to designate which routes are accepted or rejected from RIP into the route table. Import filters are applied in the order they appear in the table.
 
    [bookmark: pgfId-7207088]When adding an import filter, you use one of the filters you configured on the virtual router. For more information about configuring filters, see Setting Up Virtual Router Filters.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7172780]To add an import filter for RIP configuration:
 
   [bookmark: pgfId-7203276]Access: Admin/Network Admin
 
   
 
   [bookmark: pgfId-7203277]Step 1 Select Devices > Device Management.
 
   [bookmark: pgfId-7203278]The Device Management page appears.
 ). 
   
 
   [bookmark: pgfId-7203283]The Interfaces tab for that device appears.
 
   [bookmark: pgfId-7203284]Step 3 Click Virtual Routers.
 
   [bookmark: pgfId-7203285]The Virtual Routers tab appears.
 ). 
   
 
   [bookmark: pgfId-7203290]The Edit Virtual Router pop-up window appears.
 
   [bookmark: pgfId-7203291]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
   [bookmark: pgfId-7203292]Step 6 Click RIP to display the RIP options.
 ). 
   
 
   [bookmark: pgfId-7203297]The Add an Import Filter pop-up window appears.
 
   [bookmark: pgfId-7203298]Step 8 From the Name drop-down list, select the filter you want to add as an import filter.
 
   [bookmark: pgfId-7213083]Step 9 Next to Action, select Accept or Reject.
 
   [bookmark: pgfId-7213084]Step 10 Click OK.
 
   [bookmark: pgfId-7213085]The import filter is added.
 
    
     
   
 
   
 
   
 
   [bookmark: pgfId-7213086]Step 11 Click Save.
 
   [bookmark: pgfId-7213087]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7388823]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7202315][bookmark: 32763]Adding Export Filt[bookmark: marker-7260526]ers for RIP Configuration
 
    [bookmark: pgfId-7298520]License: Control
 
    [bookmark: pgfId-7336573]Supported Devices: Series 3
 
    [bookmark: pgfId-7298522]You can add an export filter to define which routes will be accepted or rejected from the route table to RIP. Export filters are applied in the order they appear in the table.
 
    [bookmark: pgfId-7238007]When adding an export filter, you use one of the filters you configured on the virtual router. For more information about configuring filters, see Setting Up Virtual Router Filters.
 
    [bookmark: pgfId-7238011]To add an export filter for RIP configuration:
 
    [bookmark: pgfId-7203369]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7203370]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7203371]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7203376]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7203377]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7203378]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7203383]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7203384]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7203385]Step 6 Click RIP to display the RIP options.
 ). 
    
 
    [bookmark: pgfId-7204631]The Add an Export Filter pop-up window appears.
 
    [bookmark: pgfId-7204632]Step 8 From the Name drop-down list, select the filter you want to add as an export filter.
 
    [bookmark: pgfId-7204633]Step 9 Next to Action, select Accept or Reject.
 
    [bookmark: pgfId-7213038]Step 10 Click OK.
 
    [bookmark: pgfId-7204634]The export filter is added.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7213057]Step 11 Click Save.
 
   [bookmark: pgfId-7203397]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7388846]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7172782][bookmark: 76258]Setting Up OSPF Confi[bookmark: marker-7260535]guration
 
    [bookmark: pgfId-7336601]License: Control
 
    [bookmark: pgfId-7336614]Supported Devices: Series 3
 
    [bookmark: pgfId-7336603]Open Shortest Path First (OSPF) is an adaptive routing protocol that defines routes dynamically by obtaining information from other routers and advertising routes to other routers using link state advertisements. The router keeps information about the links between it and the destination to make routing decisions. OSPF assigns a cost to each routed interface, and considers the best routes to have the lowest costs.
 
    [bookmark: pgfId-7205275]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7207363]Setting Up OSPF Routing Areas
 
     	 [bookmark: pgfId-7207603]Adding Import Filters for OSPF Configuration
 
     	 [bookmark: pgfId-7207607]Adding Export Filters for OSPF Configuration
 
    
 
   
 
    
     [bookmark: pgfId-7208496][bookmark: 43489]Setting Up OSPF Routi[bookmark: marker-7260547]ng Areas
 
    [bookmark: pgfId-7208527]License: Control
 
    [bookmark: pgfId-7336630]Supported Devices: Series 3
 
    [bookmark: pgfId-7248087]An OSPF network may be structured, or subdivided, into routing areas to simplify administration and optimize traffic and resource use. Areas are identified by 32-bit numbers, expressed either simply in decimal or often in octet-based dot-decimal notation.
 
    [bookmark: pgfId-7248088]By convention, area zero or 0.0.0.0 represents the core or backbone region of an OSPF network. You may choose to identify other areas. Often, administrators select the IP address of a main router in an area as the area's identification. Each additional area must have a direct or virtual connection to the backbone OSPF area. Such connections are maintained by an interconnecting router, known as the area border router (ABR). An ABR maintains separate link state databases for each area it serves and maintains summarized routes for all areas in the network.
 
    [bookmark: pgfId-7208775]See the following sections for more information on setting up OSPF areas:
 
     
     	 [bookmark: pgfId-7208746]Adding OSPF Areas
 
     	 [bookmark: pgfId-7208755]Adding OSPF Area Interfaces
 
     	 [bookmark: pgfId-7208758]Adding OSPF Area Vlinks
 
    
 
   
 
    
     [bookmark: pgfId-7208748][bookmark: 53288]Adding OSPF Areas
 
    [bookmark: pgfId-7210441]License: Control
 
    [bookmark: pgfId-7336647]Supported Devices: Series 3
 
    [bookmark: pgfId-7210569]The following procedure explains how to add an OSPF area and configure general settings.
 
    [bookmark: pgfId-7210570]To add an OSPF area:
 
    [bookmark: pgfId-7178099]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7208593]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7208594]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7208599]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7208600]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7208601]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7208606]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7208607]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7275945]Step 6 Click OSPF to display the OSPF options.
 ). 
    
 
    [bookmark: pgfId-7275954]The Add OSPF Area pop-up window appears.
 
    [bookmark: pgfId-7266288]Step 8 In the Area Id field, type a numerical value for the area. This value can be either an integer or an IPv4 address.
 
    [bookmark: pgfId-7208999]Step 9 Optionally, select the Stubnet check box to designate that the area does not receive router advertisements external to the autonomous system and routing from within the area is based entirely on a default route. If you clear the check box, the area becomes a backbone area or otherwise non-stub area.
 
    [bookmark: pgfId-7217675]The Default cost field and Stubnet field appear.
 
    [bookmark: pgfId-7275649]Step 10 In the Default cost field, type a cost associated with the default route for the area.
 ). 
    
 
    [bookmark: pgfId-7275654]Step 12 In the IP Address field, type an IP address in CIDR notation.
 
    [bookmark: pgfId-7217655]Step 13 Select the Hidden check box to indicate that the stubnet is hidden. Hidden stubnets are not propagated into other areas.
 
    [bookmark: pgfId-7217656]Step 14 Select the Summary check box to designate that default stubnets that are subnetworks of this stubnet are suppressed.
 
    [bookmark: pgfId-7209416]Step 15 In the Stub cost field, type a value that defines the cost associated with routing to this stub network.
 
    [bookmark: pgfId-7209453]Step 16 Click OK.
 
    [bookmark: pgfId-7238735]The stubnet is added.
 
     
      
    
 
    
 
   
 
   
 ). 
   
 
   [bookmark: pgfId-7264779]Step 18 In the IP Address field, type an IP address in CIDR notation for the network.
 
   [bookmark: pgfId-7217724]Step 19 Select the Hidden check box to indicate that the network is hidden. Hidden networks are not propagated into other areas.
 
   [bookmark: pgfId-7209609]Step 20 Click OK.
 
   [bookmark: pgfId-7238759]The network is added.
 
    
     
   
 
   
 
   
 
   [bookmark: pgfId-7209222]Step 21 Click Save.
 
   [bookmark: pgfId-7208612]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7388862]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7172787][bookmark: 39985]Adding OSPF Area Interfaces
 
    [bookmark: pgfId-7178407]License: Control
 
    [bookmark: pgfId-7336665]Supported Devices: Series 3
 
    [bookmark: pgfId-7178410]You can configure a subset of the interfaces assigned to the virtual router for OSPF. The following list describes the options you can specify on each interface.
 
    [bookmark: pgfId-7327736]Interfaces
 
    [bookmark: pgfId-7327783]Select the interface where you want to configure OSPF. Interfaces you have disabled from the Interfaces tab are not available. 
 
    [bookmark: pgfId-7327848]Type
 
    [bookmark: pgfId-7327909]Select the type of OSPF interface from the following choices:
 
    [bookmark: pgfId-7327910] – Broadcast — On broadcast networks, flooding and hello messages are sent using multicasts, a single packet for all the neighbors. The option designates a router to be responsible for synchronizing the link state databases and originating network link state advertisements. This network type cannot be used on physically non-broadcast multiple-access (NBMP) networks and on unnumbered networks without proper IP prefixes.
 
    [bookmark: pgfId-7327911] – Point-to-Point (PtP) — Point-to-point networks connect just two routers together. No election is performed and no network link state advertisement is originated, which makes it simpler and faster to establish. This network type is useful not only for physically PtP interfaces, but also for broadcast networks used as PtP links. This network type cannot be used on physically NBMP networks.
 
    [bookmark: pgfId-7327912] – Non-Broadcast — On NBMP networks, the packets are sent to each neighbor separately because of the lack of multicast capabilities. Similar to broadcast networks, the option designates a router, which plays a central role in the propagation of link state advertisements. This network type cannot be used on unnumbered networks.
 
    [bookmark: pgfId-7327889] – Autodetect — The system determines the correct type based on the specified interface.
 
    [bookmark: pgfId-7328160]Cost
 
    [bookmark: pgfId-7328169]Specify the output cost of the interface.
 
    [bookmark: pgfId-7328201]Stub
 
    [bookmark: pgfId-7328213]Specify whether the interface should listen for OSPF traffic and transmit its own traffic.
 
    [bookmark: pgfId-7329194]Priority
 
    [bookmark: pgfId-7329195]Enter a numerical value that specifies the priority value used in designated router election. On every multiple access network, the system designates a router and backup router. These routers have some special functions in the flooding process. Higher priority increases preferences in this election. You cannot configure a router with a priority of 0.
 
    [bookmark: pgfId-7329200]Nonbroadcast
 
    [bookmark: pgfId-7329214]Specify whether hello packets are sent to any undefined neighbors. This switch is ignored on any NBMA network.
 
    [bookmark: pgfId-7328322]Authentication
 
    [bookmark: pgfId-7328350]Select the OSPF authentication profile that this interface uses from one of the authentication profiles you configured on the virtual router or select None. For more information about configuring authentication profiles, see Adding Virtual Router Authentication Profiles.
 
    [bookmark: pgfId-7329556]Hello Interval
 
    [bookmark: pgfId-7329576]Type the interval, in seconds, between the sending of hello messages.
 
    [bookmark: pgfId-7329594]Poll
 
    [bookmark: pgfId-7329600]Type the interval, in seconds, between the sending of hello messages for some neighbors on NBMA networks.
 
    [bookmark: pgfId-7329622]Retrans Interval
 
    [bookmark: pgfId-7329646]Type the interval, in seconds, between retransmissions of unacknowledged updates.
 
    [bookmark: pgfId-7329675]Retrans Delay
 
    [bookmark: pgfId-7329695]Type the estimated number of seconds it takes to transmit a link state update packet over the interface.
 
    [bookmark: pgfId-7329721]Wait Time
 
    [bookmark: pgfId-7329775]Type the number of seconds that the router waits between starting election and building adjacency.
 
    [bookmark: pgfId-7329781]Dead Interval
 
    [bookmark: pgfId-7329776]Type the number of seconds that the router waits before declaring a neighbor down when not receiving messages from it. If this value is defined, it overrides the value calculated from dead count.
 
    [bookmark: pgfId-7329824]Dead Count
 
    [bookmark: pgfId-7329843]Type a numerical value that when multiplied by the hello interval specifies the number of seconds that the router waits before declaring a neighbor down when not receiving messages from it.
 ). Disabling a configured interface from the Interfaces tab also deletes it. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7323690]Note You can select only one interface for use in an OSPF area.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7172788]To add an OSPF area interface:
 
    [bookmark: pgfId-7208025]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7208074]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7208075]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7208080]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7208081]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7208082]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7208087]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7208088]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7208089]Step 6 Click OSPF to display the OSPF options.
 ). 
    
 
    [bookmark: pgfId-7208094]The Add OSPF Area pop-up window appears.
 
    [bookmark: pgfId-7210181]Step 8 Click Interfaces.
 
    [bookmark: pgfId-7210207]The Interfaces tab appears.
 ). 
    
 
    [bookmark: pgfId-7208095]The Add OSPF Area Interface pop-up window appears.
 
    [bookmark: pgfId-7211322]Step 10 Take any of the actions as described in Adding OSPF Area Interfaces.
 ). 
    
 
    [bookmark: pgfId-7211928]Step 12 In the IP address field, type an IP address for the neighbor receiving hello messages on non-broadcast networks from this interface.
 
    [bookmark: pgfId-7211970]Step 13 Select the Eligible check box to indicate that the neighbor is eligible to receive messages.
 
    [bookmark: pgfId-7212055]Step 14 Click OK.
 
    [bookmark: pgfId-7212071]The neighbor is added.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7212516]Step 15 Click OK.
 
   [bookmark: pgfId-7212379]The OSPF area interface is added.
 
   [bookmark: pgfId-7212421]Step 16 Click Save.
 
   [bookmark: pgfId-7212440]The OSPF area is saved.
 
   [bookmark: pgfId-7208102]Step 17 Click Save.
 
   [bookmark: pgfId-7208026]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7389020]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7208027][bookmark: 19883]Adding OSPF Area Vlinks
 
    [bookmark: pgfId-7208028]License: Control
 
    [bookmark: pgfId-7336683]Supported Devices: Series 3
 
    [bookmark: pgfId-7178473]All areas in an OSPF autonomous system must be physically connected to the backbone area. In some cases where this physical connection is not possible, you can use a vlink to connect to the backbone through a non-backbone area. Vlinks can also be used to connect two parts of a partitioned backbone through a non-backbone area.
 
    [bookmark: pgfId-7250756]You must add a minimum of two OSPF areas before you can add a vlink.
 
    [bookmark: pgfId-7172790]To add an OSPF area vlink:
 
    [bookmark: pgfId-7178552]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7208145]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7208146]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7208151]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7208152]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7208153]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7208158]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7208159]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7208160]Step 6 Click OSPF to display the OSPF options.
 ). 
    
 
    [bookmark: pgfId-7208165]The Add OSPF Area pop-up window appears.
 
    [bookmark: pgfId-7212477]Step 8 Click Vlinks.
 
    [bookmark: pgfId-7212500]The Vlinks tab appears.
 ). 
    
 
    [bookmark: pgfId-7276617]The Add OSPF Area Vlink pop-up window appears.
 
    [bookmark: pgfId-7276621]Step 10 In the Router ID field, type an IP address for the router.
 
    [bookmark: pgfId-7212585]Step 11 From the Authentication drop-down list, select the authentication profile the vlink will use.
 
    [bookmark: pgfId-7213442]Step 12 In the Hello Interval field, type the interval, in seconds, between sending of hello messages.
 
    [bookmark: pgfId-7212601]Step 13 In the Retrans Interval field, type the interval, in seconds, between retransmissions of unacknowledged updates.
 
    [bookmark: pgfId-7212605]Step 14 In the Wait Time field, type the number of seconds that the router waits between starting election and building adjacency.
 
    [bookmark: pgfId-7212607]Step 15 In the Dead Interval field, type the number of seconds that the router waits before declaring a neighbor down when not receiving messages from it. If this value is defined, it overrides the value calculated from dead count.
 
    [bookmark: pgfId-7212609]Step 16 In the Dead Count field, type a numerical value that when multiplied by the hello interval, specifies the number of seconds that the router waits before declaring a neighbor down when not receiving messages from it.
 
    [bookmark: pgfId-7212611]Step 17 Click OK.
 
    [bookmark: pgfId-7212612]The OSPF area vlink is added.
 
    [bookmark: pgfId-7212613]Step 18 Click Save.
 
    [bookmark: pgfId-7212614]The OSPF area is saved.
 
    [bookmark: pgfId-7212615]Step 19 Click Save.
 
    [bookmark: pgfId-7212616]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7389067]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7179324][bookmark: 74721]Adding Import Filters for OSPF Config[bookmark: marker-7260627]uration
 
    [bookmark: pgfId-7205750]License: Control
 
    [bookmark: pgfId-7336699]Supported Devices: Series 3
 
    [bookmark: pgfId-7207368]You can add an import filter to define which routes are accepted or rejected from OSPF into the route table. Import filters are applied in the order they appear in the table.
 
    [bookmark: pgfId-7205751]When adding an import filter, you use one of the filters you configured on the virtual router. For more information about configuring filters, see Setting Up Virtual Router Filters.
 
    [bookmark: pgfId-7205755]To add an import filter for OSPF configuration:
 
    [bookmark: pgfId-7205756]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7205757]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7205758]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7205763]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7205764]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7205765]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7205770]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7205771]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7205772]Step 6 Click OSPF to display the OSPF options.
 ). 
    
 
    [bookmark: pgfId-7205777]The Add Import Filter pop-up window appears.
 
    [bookmark: pgfId-7205778]Step 8 From the Name drop-down list, select the filter you want to add as an import filter.
 
    [bookmark: pgfId-7205779]Step 9 Next to Action, select Accept or Reject.
 
    [bookmark: pgfId-7212777]Step 10 Click OK.
 
    [bookmark: pgfId-7212798]The import filter is added.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7205780]Step 11 Click Save.
 
   [bookmark: pgfId-7205781]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7389076]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7205701][bookmark: 53512]Adding Export Filters for OS[bookmark: marker-7260641]PF Configuration
 
    [bookmark: pgfId-7205839]License: Control
 
    [bookmark: pgfId-7336721]Supported Devices: Series 3
 
    [bookmark: pgfId-7207384]You can add an export filter to define which routes will be accepted or rejected from the route table to OSPF. Export filters are applied in the order they appear in the table.
 
    [bookmark: pgfId-7205840]When adding an export filter, you use one of the filters you configured on the virtual router. For more information about configuring filters, see Setting Up Virtual Router Filters.
 
    [bookmark: pgfId-7205844]To add an export filter for OSPF configuration:
 
    [bookmark: pgfId-7205845]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7205846]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7205847]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7205852]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7205853]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7205854]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7205859]The Edit Virtual Router pop-up window appears.
 
    [bookmark: pgfId-7205860]Step 5 Click Dynamic Routing to display the dynamic routing options.
 
    [bookmark: pgfId-7205861]Step 6 Click OSPF to display the OSPF options.
 ). 
    
 
    [bookmark: pgfId-7205866]The Add an Export Filter pop-up window appears.
 
    [bookmark: pgfId-7205867]Step 8 From the Name drop-down list, select the filter you want to add as an export filter.
 
    [bookmark: pgfId-7205868]Step 9 Next to Action, select Accept or Reject.
 
    [bookmark: pgfId-7212914]Step 10 Click OK.
 
    [bookmark: pgfId-7212943]The export filter is added.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7212958]Step 11 Click Save.
 
   [bookmark: pgfId-7205939]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7389103]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7298852][bookmark: 66665]Setting Up Virtual Ro[bookmark: marker-7298851]uter Filters
 
    [bookmark: pgfId-7298856]License: Control
 
    [bookmark: pgfId-7336743]Supported Devices: Series 3
 
    [bookmark: pgfId-7298857]Filters provide a way to match routes for importing into the virtual router’s route table and for exporting routes to dynamic protocols. You can create and manage a list of filters. Each filter defines specific criteria to look for in routes that are defined statically or received from a dynamic protocol.
 
     
      
    
 
    
 
   
 
   
 
    
     
      
      [bookmark: pgfId-7197016]Table 7-3 Virtual Router Filters Table View Fields 
 
      
      
       
       	 
         
         [bookmark: pgfId-7197020]Field 
        
  
       	 
         
         [bookmark: pgfId-7197022]Description 
        
  
      
 
       
       	[bookmark: pgfId-7197024]Name
  
       	[bookmark: pgfId-7197026]The name of the filter.
  
      
 
       
       	[bookmark: pgfId-7197028]Protocol
  
       	[bookmark: pgfId-7197030]The protocol that the route originates from:
 
         
         	 [bookmark: pgfId-7216753]Static — The route originates as a local static route.
 
         	 [bookmark: pgfId-7216758]RIP — The route originates from a dynamic RIP configuration.
 
         	 [bookmark: pgfId-7216789]OSPF — The route originates from a dynamic OSPF configuration.
 
        
  
      
 
       
       	[bookmark: pgfId-7197032]From Router
  
       	[bookmark: pgfId-7197034]The router IP addresses that this filter attempts to match in a router. You must enter this value for static and RIP filters.
  
      
 
       
       	[bookmark: pgfId-7197036]Next Hop
  
       	[bookmark: pgfId-7197045]The next hop where packets using this route are forwarded. You must enter this value for static and RIP filters.
  
      
 
       
       	[bookmark: pgfId-7197047]Destination Type
  
       	[bookmark: pgfId-7197049]The type of destination where packets are sent:
 
         
         	 [bookmark: pgfId-7216927]Router
 
         	 [bookmark: pgfId-7217007]Device
 
         	 [bookmark: pgfId-7217021]Discard
 
        
  
      
 
       
       	[bookmark: pgfId-7197051]Destination Network
  
       	[bookmark: pgfId-7197053]The networks that this filter attempts to match in a route.
  
      
 
       
       	[bookmark: pgfId-7197267]OSPF Path Type
  
       	[bookmark: pgfId-7197269]Applies only to OSPF protocol. The path type can be one of the following:
 
         
         	 [bookmark: pgfId-7238112]Ext-1
 
         	 [bookmark: pgfId-7238126]Ext-2
 
         	 [bookmark: pgfId-7238133]Inter Area
 
         	 [bookmark: pgfId-7238140]Intra Area
 
        
  
      
 
       
       	[bookmark: pgfId-7197263]OSPF Router ID
  
       	[bookmark: pgfId-7197265]Applies only to OSPF protocol. The router ID of the router advertising that route/network.
  
      
 
      
    
 
   
 
   [bookmark: pgfId-7214489]To add a virtual router filter:
 
   [bookmark: pgfId-7179746]Access: Admin/Network Admin
 
   
 
   [bookmark: pgfId-7204898]Step 1 Select Devices > Device Management.
 
   [bookmark: pgfId-7204899]The Device Management page appears.
 ). 
   
 
   [bookmark: pgfId-7204904]The Interfaces tab for that device appears.
 
   [bookmark: pgfId-7204905]Step 3 Click Virtual Routers.
 
   [bookmark: pgfId-7204906]The Virtual Routers tab appears.
 ). 
   
 
   [bookmark: pgfId-7204911]The Edit Virtual Router pop-up window appears.
 
   [bookmark: pgfId-7204912]Step 5 Click Filter to display the Filter options.
 
   [bookmark: pgfId-7214448]Step 6 Click Add Filter.
 
   [bookmark: pgfId-7204913]The Create Filter pop-up window appears.
 
   [bookmark: pgfId-7214551]Step 7 In the Name field, type a name for the filter. You can use alphanumeric characters only.
 
   [bookmark: pgfId-7214621]Step 8 Under Protocol, select All or select the protocol that applies to the filter.
 
   [bookmark: pgfId-7214736]Step 9 If you selected All, Static, or RIP as the Protocol, under From Router, type the router IP addresses that this filter will attempt to match in a route.
 
   [bookmark: pgfId-7240887]Note that you can also enter a /32 CIDR block for IPv4 addresses and a /128 prefix length for IPv6 addresses. All other address blocks are invalid for this field.
 
   [bookmark: pgfId-7214921]Step 10 Click Add.
 
   [bookmark: pgfId-7214944]The From Router field is populated.
 
   [bookmark: pgfId-7214830]Step 11 If you selected All, Static, or RIP as the Protocol, under Next Hop, type the IP addresses for the gateways that this filter will attempt to match in a route.
 
   [bookmark: pgfId-7241059]Note that you can also enter a /32 CIDR block for IPv4 addresses and a /128 prefix length for IPv6 addresses. All other address blocks are invalid for this field.
 
   [bookmark: pgfId-7214981]Step 12 Click Add.
 
   [bookmark: pgfId-7214996]The Next Hop field is populated.
 
   [bookmark: pgfId-7215034]Step 13 Under Destination Type, select the options that apply to the filter.
 
   [bookmark: pgfId-7215106]Step 14 Under Destination Network, type the IP address of the network that this filter will attempt to match in a route.
 
   [bookmark: pgfId-7215419]Step 15 Click Add.
 
   [bookmark: pgfId-7215186]The Destination Network field is populated.
 
   [bookmark: pgfId-7215243]Step 16 If you selected All or OSPF as the Protocol, under Path Type, select the options that apply to the filter.
 
   [bookmark: pgfId-7275171]You must select at least one path type.
 
   [bookmark: pgfId-7215306]Step 17 If you selected OSPF as the Protocol, under Router ID, type the IP address that serves as the router ID of the router advertising the route/network.
 
   [bookmark: pgfId-7215416]Step 18 Click Add.
 
   [bookmark: pgfId-7215484]The Router ID field is populated.
 
   [bookmark: pgfId-7215531]Step 19 Click OK.
 
   [bookmark: pgfId-7215547]The filter is added.
 
   [bookmark: pgfId-7215574]Step 20 Click Save.
 
   [bookmark: pgfId-7215614]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7389109]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7172830][bookmark: 45222]Adding Virtual Router Authenti[bookmark: marker-7260741]cation Profiles
 
    [bookmark: pgfId-7179681]License: Control
 
    [bookmark: pgfId-7336763]Supported Devices: Series 3
 
    [bookmark: pgfId-7179686]You can set up Authentication Profiles for use in RIP and OSPF configurations. You can configure a simple password or specify a shared cryptographic key. Simple passwords allow for every packet to carry eight bytes of the password. The system ignores received packets lacking this password. Cryptographic keys allow for validation, a 16-byte long digest generated from a password to be appended to every packet.
 
    [bookmark: pgfId-7216206]Note that for OSPF, each area can have a different authentication method. Therefore, you create authentication profiles that can be shared among many areas. You cannot add authentication for OSPFv3.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7179726]To add a virtual router authentication profile:
 
   [bookmark: pgfId-7180093]Access: Admin/Network Admin
 
   
 
   [bookmark: pgfId-7213617]Step 1 Select Devices > Device Management.
 
   [bookmark: pgfId-7213618]The Device Management page appears.
 ). 
   
 
   [bookmark: pgfId-7213623]The Interfaces tab for that device appears.
 
   [bookmark: pgfId-7213624]Step 3 Click Virtual Routers.
 
   [bookmark: pgfId-7213625]The Virtual Routers tab appears.
 ). 
   
 
   [bookmark: pgfId-7213630]The Edit Virtual Router pop-up window appears.
 
   [bookmark: pgfId-7213838]Step 5 Click Authentication Profile.
 
   [bookmark: pgfId-7213887]The Authentication Profile tab appears.
 
   [bookmark: pgfId-7213636]Step 6 Click Add Authentication Profile.
 
   [bookmark: pgfId-7270992]The Add Authentication Profile pop-up window appears.
 
   [bookmark: pgfId-7270997]Step 7 In the Authentication Profile Name field, type a name for the authentication profile.
 
   [bookmark: pgfId-7213639]Step 8 From the Authentication Type drop down list, select simple or cryptographic.
 
   [bookmark: pgfId-7214098]Step 9 In the Password field, type a secure password.
 
   [bookmark: pgfId-7214156]Step 10 In the Confirm Password field, type the password again to confirm it.
 
   [bookmark: pgfId-7213640]Step 11 Click OK.
 
   [bookmark: pgfId-7213641]The authentication profile is added.
 
   [bookmark: pgfId-7213696]Step 12 Click Save.
 
   [bookmark: pgfId-7213724]Your changes are saved. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7389131]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7179606][bookmark: 24294]Viewing Virtual Ro[bookmark: marker-7260754]uter Statistics
 
    [bookmark: pgfId-7175276]License: Control
 
    [bookmark: pgfId-7336780]Supported Devices: Series 3
 
    [bookmark: pgfId-7172831]You can view runtime statistics for each virtual router. The statistics display unicast packets, packets dropped, and separate routing tables for IPv4 and IPv6 addresses.
 
    [bookmark: pgfId-7175325]To view virtual router statistics:
 
    [bookmark: pgfId-7175375]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7234860]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7234861]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7234866]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7234867]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7234868]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7235191]The Statistics pop-up window appears.
 
    [bookmark: pgfId-7235251]Step 5 Click OK to close the window.
 
    [bookmark: pgfId-7389137]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7172832]Deleting [bookmark: Deleting Virtual Routers]Virtua[bookmark: marker-7260763]l Routers
 
    [bookmark: pgfId-7175174]License: Control
 
    [bookmark: pgfId-7336796]Supported Devices: Series 3
 
    [bookmark: pgfId-7172833]When you delete a virtual router, any routed interfaces assigned to the router become available for inclusion in another router.
 
    [bookmark: pgfId-7175221]To delete a virtual router:
 
    [bookmark: pgfId-7175264]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7185322]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7185323]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7185328]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7185329]Step 3 Click Virtual Routers.
 
    [bookmark: pgfId-7185330]The Virtual Routers tab appears.
 ). 
    
 
    [bookmark: pgfId-7185335]Step 5 When prompted, confirm that you want to delete the virtual router.
 
    [bookmark: pgfId-7185336]The virtual router is deleted. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7389143]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7172834]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7266780][bookmark: 95833]Setting Up Aggreg[bookmark: marker-7266779]ate Interfaces 
      
      
 
     
 
 
    [bookmark: pgfId-7267708]You can group multiple physical Ethernet interfaces into a single logical link on Series 3 managed devices configured in either a Layer 2 deployment that provides packet switching between networks, or a Layer 3 deployment that routes traffic between interfaces. This single aggregate logical link provides higher bandwidth, redundancy, and load-balancing between two endpoints. 
 
    [bookmark: pgfId-7233457]You create aggregate links by creating a switched or routed link aggregation group, or LAG. When you create an aggregation group, a logical interface called an aggregate interface is created. To an upper layer entity a LAG looks like a single logical link and data traffic is transmitted through the aggregate interface. The aggregate link provides increased bandwidth by adding the bandwidth of multiple links together. It also provides redundancy by load-balancing traffic across all available links. If one link fails, the system automatically load-balances traffic across all remaining links. 
 
     
      [bookmark: pgfId-7265166]
 
     [bookmark: pgfId-7263553]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7233704]The endpoints in a LAG can be two FirePOWER managed devices, as shown in the illustration above, or a FirePOWER managed device connected to a third-party access switch or router. The two devices do not have to match, but they must have the same physical configuration and they must support the IEEE 802.ad link aggregation standard. A typical deployment for a LAG might be to aggregate access links between two managed devices, or to create a point-to-point connection between a managed device and an access switch or a router. 
 
     [bookmark: pgfId-7224157]Note that you cannot configure aggregate interfaces on a virtual managed device, a Cisco ASA with FirePOWER Services device, or a Cisco NGIPS for Blue Coat X-Series device. 
 
     [bookmark: pgfId-7200366]For more information about setting up aggregate interfaces, see Configuring LAGs. 
 
    
 
   
 
    
     [bookmark: pgfId-7225964][bookmark: 37631]Configuring LAGs[bookmark: marker-7243878]
 
    [bookmark: pgfId-7230575]License: Control
 
    [bookmark: pgfId-7230582]Supported Devices: Series 3
 
    [bookmark: pgfId-7247993]There are two types of aggregate interfaces: switched, which are Layer 2 aggregate interfaces, and routed, which are Layer 3 aggregate interfaces. You implement link aggregation through the use of link aggregation groups (LAGs). You configure a LAG by creating an aggregate switched or routed interface and then associating a set of physical interfaces with the link. All of the physical interfaces must be of the same speed and medium. 
 
    [bookmark: pgfId-7247994]You create aggregate links either dynamically or statically. Dynamic link aggregation uses Link Aggregation Control Protocol (LACP), a component of the IEEE 802.ad link aggregation standard, while static link aggregation does not. LACP enables each device on either end of the LAG to exchange link and system information to determine which links will be actively used in the aggregation. A static LAG configuration requires you to manually maintain link aggregations and apply load-balancing and link selection policies.
 
    [bookmark: pgfId-7248384]When you create a switched or routed aggregate interface, a link aggregation group of the same type is created and numbered automatically. For example, when you create your first LAG (switched or routed), the aggregate interface can be identified by the lag0 label in the Interfaces tab for your managed device. When you associate physical and logical interfaces with this LAG, they appear nested below the primary LAG in a hierarchical tree menu. Note that a switched LAG can only contain switched physical interfaces, and a routed LAG can only contain routed physical interfaces.
 
    [bookmark: pgfId-7220971]Consider the following requirements when you configure a LAG: 
 
     
     	 [bookmark: pgfId-7234855]The FireSIGHT system supports a maximum of 14 LAGs, and assigns a unique ID to each LAG interface in the range of 0 to 13. The LAG ID is not configurable. 
 
     	 [bookmark: pgfId-7236629]You must configure the LAG on both sides of the link, and you must set the interfaces on either side of the link to the same speed. 
 
     	 [bookmark: pgfId-7249484]You must associate at least two physical interfaces per LAG, up to a maximum of eight. A physical interface cannot belong to more than one LAG. 
 
     	 [bookmark: pgfId-7249485]Physical interfaces in a LAG cannot be used in any other mode of operation, either as inline or passive, or be used as part of another logical interface for tagged traffic. 
 
     	 [bookmark: pgfId-7249481]Physical interfaces in a LAG can span multiple NetMods, but cannot span multiple sensors (i.e. all physical interfaces must reside on the same device). 
 
     	 [bookmark: pgfId-7236857]A LAG cannot contain a stacking NetMod. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7249491]Note Link aggregation is not supported on device clusters.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7244400]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7244404]Specifying a Load-Balancing Algorithm
 
     	 [bookmark: pgfId-7244573]Specifying a Link Selection Policy
 
     	 [bookmark: pgfId-7244408]Configuring LACP
 
     	 [bookmark: pgfId-7244412]Adding Aggregate Switched Interfaces
 
     	 [bookmark: pgfId-7244618]Adding Aggregate Routed Interfaces
 
     	 [bookmark: pgfId-7244637]Adding Logical Aggregate Interfaces
 
     	 [bookmark: pgfId-7244656]Viewing Aggregate Interface Statistics
 
     	 [bookmark: pgfId-7272536]Deleting Aggregate Interfaces
 
    
 
     
      [bookmark: pgfId-7242705][bookmark: 73449]Specifying a Load-Balancing Algorithm [bookmark: marker-7265692]
 
     [bookmark: pgfId-7242712]License: Control
 
     [bookmark: pgfId-7230675]Supported Devices: Series 3
 
     [bookmark: pgfId-7236069]You assign an egress load-balancing algorithm to the LAG that determines how to distribute traffic to the LAG bundle’s member links. The load-balancing algorithm makes hashing decisions based on values in various packet fields, such as Layer 2 MAC addresses, Layer 3 IP addresses, and Layer 4 port numbers (TCP/UDP traffic). The load-balancing algorithm you select applies to all of the LAG bundle’s member links.
 
     [bookmark: pgfId-7236254]Select the load-balancing algorithm that supports your deployment scenario from the following options when you configure a LAG:
 
      
      	 [bookmark: pgfId-7228862]Destination IP
 
      	 [bookmark: pgfId-7229510]Destination MAC
 
      	 [bookmark: pgfId-7229579]Destination Port
 
      	 [bookmark: pgfId-7229648]Source IP
 
      	 [bookmark: pgfId-7229717]Source MAC
 
      	 [bookmark: pgfId-7229786]Source Port 
 
      	 [bookmark: pgfId-7229855]Source and Destination IP
 
      	 [bookmark: pgfId-7230025]Source and Destination MAC
 
      	 [bookmark: pgfId-7230026]Source and Destination Port
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7230032]Note You should configure both ends of the LAG to have the same load-balancing algorithm. Higher layer algorithms will back off to lower layer algorithms as necessary (such as a Layer 4 algorithm backing off to Layer 3 for ICMP traffic).
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7242694][bookmark: 60916]Specifying a Link Selection Policy[bookmark: marker-7265697]
 
     [bookmark: pgfId-7242701]License: Control
 
     [bookmark: pgfId-7230794]Supported Devices: Series 3
 
     [bookmark: pgfId-7260545]Link aggregation requires the speed and medium of each link to be the same at both endpoints. Because link properties can change dynamically, the link selection policy helps determine how the system manages the link selection process. A link selection policy that maximizes the highest port count supports link redundancy, while a link selection policy that maximizes total bandwidth supports overall link speed. A stable link selection policy attempts to minimize excessive changes in link states.
 
      
       
     
 
     
 
     [bookmark: pgfId-7260546]Note You should configure both ends of the LAG to have the same link selection policy. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7260547]Select the link selection policy that supports your deployment scenario from the following options when you configure a LAG:
 
      
      	 [bookmark: pgfId-7252845]Highest Port Count — select this option for the highest total active port count to provide added redundancy.
 
      	 [bookmark: pgfId-7252933]Highest Total Bandwidth — select this option to provide the highest total bandwidth for the aggregated link.
 
      	 [bookmark: pgfId-7261817]Stable — select this option if your primary concern is link stability and reliability. Once you configure a LAG, the active links change only when absolutely necessary (such as link failure) rather than doing so for added port count or bandwidth. 
 
      	 [bookmark: pgfId-7261818]LACP Priority — select this option to use the LACP algorithm to determine which links are active in the LAG. This setting is appropriate if you have undefined deployment goals, or if the device at the other end of the LAG is a non-FirePOWER device. 
 
     
 
     [bookmark: pgfId-7253097]When LACP is enabled, a link selection policy based on LACP priority uses two properties of LACP, the system priority and link priority, which are described as follows: 
 
     [bookmark: pgfId-7253835] – LACP system priority. You configure this value on each partnered device running LACP to determine which one is superior in link aggregation. The system with the lower value has the higher system priority. In dynamic link aggregation, the system with the higher LACP system priority sets the selected state of member links on its side first, then the system with the lower priority sets its member links accordingly. You can specify 0 to 65535. If you do not specify a value, the default priority is 32768.
 
     [bookmark: pgfId-7261708] – LACP link priority. You configure this value on each link belonging to the aggregation group. The link priority determines the active and standby links in the LAG. Links with lower values have higher priority. If an active link goes down, the standby link with the highest priority is selected to replace the downed link. However, if two or more links have the same LACP link priority, the link with the lowest physical port number is selected as the standby link. You can specify 0 to 65535. If you do not specify a value, the default priority is 32768.
 
     [bookmark: pgfId-7242074]LACP is a key aspect of automating the link selection method that supports dynamic link aggregation. For more information, see Configuring LACP.
 
    
 
     
      [bookmark: pgfId-7227372][bookmark: 37546]Configuring LACP[bookmark: marker-7265702]
 
     [bookmark: pgfId-7230817]License: Control
 
     [bookmark: pgfId-7230824]Supported Devices: Series 3
 
     [bookmark: pgfId-7227630]Link Aggregation Control Protocol (LACP), a component of IEEE 802.3ad, is a method of exchanging system and port information to create and maintain LAG bundles. When you enable LACP, each device on either end of the LAG uses LACP to determine which links will be actively used in the aggregation. LACP provides availability and redundancy by exchanging LACP packets (or control messages) between links. It learns the capabilities of the links dynamically and informs the other links. Once LACP identifies correctly matched links, it facilitates grouping the links into the LAG. If a link fails, traffic continues on the remaining links. LACP must be enabled at both ends of the LAG for the link to be operational.
 
     [bookmark: pgfId-7238108]When you enable LACP, you need to select a transmission mode for each end of the LAG that determines how LACP packets are exchanged between partnered devices. There are two options for LACP mode:
 
      
      	 [bookmark: pgfId-7238109]Active — select this mode to place a device into an active negotiating state, in which the device initiates negotiations with remote links by sending LACP packets.
 
      	 [bookmark: pgfId-7237666]Passive — select this mode to place a device into a passive negotiating state, in which the device responds to LACP packets it receives but does not initiate LACP negotiation.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7237568]Note Both modes allow LACP to negotiate between links to determine if they can form a link bundle based on criteria such as port speed. However, you should avoid a passive-passive configuration, which essentially places both ends of the LAG in listening mode.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7238572]LACP has a timer which defines how often LACP packets are sent between devices. LACP exchanges packets at these rates:
 
      
      	 [bookmark: pgfId-7238573]Slow — 30 seconds 
 
      	 [bookmark: pgfId-7238423]Fast — 1 second 
 
     
 
     [bookmark: pgfId-7238684]The device where this option is applied expects to receive LACP packets with this frequency from the partner device on the other side of the LAG.
 
      
       
     
 
     
 
     [bookmark: pgfId-7249659]Note When a LAG is configured on a managed device that is part of a device stack, only the primary device participates in LACP communication with the partner system. All secondary devices forward LACP messages to the primary device. The primary device relays any dynamic LAG modifications to the secondary devices.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7222216][bookmark: 86113]Adding Aggregate Switc[bookmark: marker-7222215]hed Interfaces
 
     [bookmark: pgfId-7218203]License: Control 
 
     [bookmark: pgfId-7218047]Supported Devices: Series 3 
 
     [bookmark: pgfId-7222743]You can combine between two and eight physical ports on a managed device to create a switched LAG interface. You must assign a switched LAG interface to a virtual switch before it can handle traffic. A managed device can support up to 14 LAG interfaces. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7274798] 
      Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
      How Snort Restarts Affect Traffic. 
       
       
 
      
 
     
 ) next to the interface. 
     
 
     [bookmark: pgfId-7218056]To configure a switched LAG interface:
 
     [bookmark: pgfId-7218060]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7218061]Step 1 Select Devices > Device Management.
 
     [bookmark: pgfId-7218062]The Device Management page appears.
 ). 
     
 
     [bookmark: pgfId-7218067]The Interfaces tab appears.
 
     [bookmark: pgfId-7222878]Step 3 From the Add drop-down menu, select Add Aggregate Interface.
 
     [bookmark: pgfId-7218073]Step 4 Click Switched to display the switched LAG interface options.
 
     [bookmark: pgfId-7218074]Step 5 Optionally, from the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
     [bookmark: pgfId-7218075]Step 6 From the Virtual Switch drop-down list, you must select an existing virtual switch or select New to add a new virtual switch. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7218076]Note If you add a new virtual switch, you must configure it on the Virtual Switches tab of the Device Management page (Devices > Device Management > Virtual Switches) after you set up the switched interface. See Adding Virtual Switches.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7218080]Step 7 Select the Enabled check box to allow the switched LAG interface to handle traffic.
 
     [bookmark: pgfId-7218081]If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.
 
     [bookmark: pgfId-7237063]Step 8 From the Mode drop-down list, select an option to designate the link mode or select Autonegotiation to specify that the interface is configured to auto negotiate speed and duplex settings. Note that mode settings are available only for copper interfaces.
 
      
       
     
 
     
 
     [bookmark: pgfId-7237067]Note Interfaces on 8000 Series appliances do not support half-duplex options. When links auto negotiate speed, all active links are selected for the LAG based on the same speed setting.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7237068]Step 9 From the MDI/MDIX drop-down list, select an option to designate whether the interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX. Note that MDI/MDIX settings are available only for copper interfaces.
 
     [bookmark: pgfId-7218088]By default, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.
 
     [bookmark: pgfId-7218089]Step 10 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed.
 
     [bookmark: pgfId-7218093]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
     [bookmark: pgfId-7218097]Step 11 Under Link Aggregation, you have two options for selecting physical interfaces to add to the LAG bundle:
 
      
       
       	 [bookmark: pgfId-7231253]Next to  Available Interfaces , select one or more interfaces, then click the add selected icon (
 
      
 
      [image: ] ). Use 
       Ctrl or 
       Shift to select multiple physical interfaces. 
     
 
      
       
       	 [bookmark: pgfId-7231257]To add all interface pairs to the LAG bundle, click the add all icon (
 
      
 
      [image: ] ). 
     
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7265901]Step 12 From the Load-Balancing Algorithm drop-down list, select the option that supports your deployment scenario. See Specifying a Load-Balancing Algorithm for more information.
 
    [bookmark: pgfId-7265905]Step 13 From the Link Selection Policy drop-down list, select the option that supports your deployment scenario: Highest Port Count (redundancy), Highest Total Bandwidth (speed), Stable (no excessive change in maintain link state), or LACP Priority (automatic link aggregation). 
 
    [bookmark: pgfId-7265906]If you select LACP Priority, you need to assign a value for System Priority. You then need to click the Configure Interface Priority link to assign a priority value for each interface in the LAG. You can specify 0 to 65535. If you do not specify a value, the default priority is 32768. See Specifying a Link Selection Policy for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-7272270]Note Select LACP Priority when you configure an aggregate interface between a FireSIGHT System device and a third-party network device.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7266014]Step 14 From the Tunnel Level drop-down list, select the option that supports your deployment scenario, either Inner or Outer. 
 
    [bookmark: pgfId-7266170]Note that the tunnel level only applies to IPv4 traffic when Layer 3 load balancing is configured. The outer tunnel is always used for Layer 2 and IPv6 traffic. If the Tunnel Level is not explicitly set, the default is Outer.
 
    [bookmark: pgfId-7219058]Step 15 Under LACP, select the Enabled check box to allow the switched LAG interface to handle traffic using the Link Aggregation Control Protocol. See Configuring LACP for more information.
 
    [bookmark: pgfId-7239286]If you clear the check box, the LAG interface becomes a static configuration and the FireSIGHT System will use all of the physical interfaces selected for the aggregation.
 
    [bookmark: pgfId-7218829]Step 16 Select a Rate radio button to set the frequency that determines how often LACP control messages are received from the partner device.
 
     
      
      	 [bookmark: pgfId-7239834]Select  Slow to receive packets every 30 seconds.
 
      	 [bookmark: pgfId-7240027]Select  Fast to receive packets every 1 second.
 
     
 
    
 
    [bookmark: pgfId-7240126]Step 17 Select a Mode radio button to establish the listening mode of the device.
 
     
      
      	 [bookmark: pgfId-7240127]Select  Active to initiate negotiations with remote links by sending LACP packets to the partner device.
 
      	 [bookmark: pgfId-7240128]Select  Passive to respond to LACP packets received. 
 
     
 
    
 
    [bookmark: pgfId-7239661]Step 18 Click Save.
 
    [bookmark: pgfId-7218098]The switched LAG interface is configured. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices for more information.
 
    [bookmark: pgfId-7223046]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7223050][bookmark: 26319]Adding Aggregate Routed Inte[bookmark: marker-7223049]rfaces
 
    [bookmark: pgfId-7218457]License: Control
 
    [bookmark: pgfId-7222372]Supported Devices: Series 3
 
    [bookmark: pgfId-7222374]You can combine between two and eight physical ports on a managed device to create a routed LAG interface. You must assign a routed LAG interface to a virtual router before it can route traffic. A managed device can support up to 14 LAG interfaces.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7276288] 
     Caution Adding a routed interface pair on a Series 3 device restarts the Snort process when you apply your changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7218468]You can add static Address Resolution Protocol (ARP) entries to a routed LAG interface. If an external host needs to know the MAC address of the destination IP address it needs to send traffic to on your local network, it sends an ARP request. When you configure static ARP entries, the virtual router responds with an IP address and associated MAC address.
 
    [bookmark: pgfId-7254564]Note that disabling the ICMP Enable Responses option for routed LAG interfaces does not prevent ICMP responses in all scenarios. You can add rules to an access control policy to drop packets where the destination IP is the routed interface’s IP and the protocol is ICMP; see Controlling Traffic with Network-Based Rules.
 
    [bookmark: pgfId-7258092]If you have enabled the Inspect Local Router Traffic option on the managed device, it drops the packets before they reach the host, thereby preventing any response. For more information about inspecting local router traffic, see Understanding Advanced Device Settings.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7274814] 
     Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 ) next to the interface. 
    
 
    [bookmark: pgfId-7218483]To configure a routed LAG interface:
 
    [bookmark: pgfId-7218487]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7218488]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7218489]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7218494]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-7222553]Step 3 From the Add drop-down menu, select Add Aggregate Interface.
 
    [bookmark: pgfId-7218500]Step 4 Click Routed to display the routed LAG interface options.
 
    [bookmark: pgfId-7218501]Step 5 Optionally, from the Security Zone drop-down list, select an existing security zone or select New to add a new security zone.
 
    [bookmark: pgfId-7218502]Step 6 From the Virtual Router drop-down list, you must select an existing virtual router or select New to add a new virtual router.
 
     
      
    
 
    
 
    [bookmark: pgfId-7218503]Note If you add a new virtual router, you must configure it on the Virtual Routers tab of the Device Management page (Devices > Device Management > Virtual Routers) after you set up the routed interface. See Adding Virtual Routers.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7218507]Step 7 Select the Enabled check box to allow the routed LAG interface to handle traffic.
 
    [bookmark: pgfId-7218508]If you clear the check box, the interface becomes disabled so that users cannot access it for security purposes.
 
    [bookmark: pgfId-7218509]Step 8 From the Mode drop-down list, select an option to designate the link mode or select Autonegotiation to specify that the LAG interface is configured to auto negotiate speed and duplex settings. Note that mode settings are available only for copper interfaces.
 
     
      
    
 
    
 
    [bookmark: pgfId-7239820]Note Interfaces on 8000 Series appliances do not support half-duplex options. When links auto negotiate speed, all active links are selected for the LAG based on the same speed setting.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7239821]Step 9 From the MDI/MDIX drop-down list, select an option to designate whether the LAG interface is configured for MDI (medium dependent interface), MDIX (medium dependent interface crossover), or Auto-MDIX. Note that MDI/MDIX settings are available only for copper interfaces.
 
    [bookmark: pgfId-7218512]Normally, MDI/MDIX is set to Auto-MDIX, which automatically handles switching between MDI and MDIX to attain link.
 
    [bookmark: pgfId-7218513]Step 10 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed. Note that the MTU is the Layer 2 MTU/MRU and not the Layer 3 MTU.
 
    [bookmark: pgfId-7218517]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
    [bookmark: pgfId-7218521]Step 11 Next to ICMP, select the Enable Responses check box to allow the LAG interface to respond to ICMP traffic such as pings and traceroute.
 
    [bookmark: pgfId-7218522]Step 12 Next to IPv6 NDP, select the Enable Router Advertisement check box to enable the LAG interface to broadcast router advertisements.
 
    [bookmark: pgfId-7218523]Step 13 To add an IP address, click Add.
 
    [bookmark: pgfId-7218524]The Add IP Address pop-up window appears.
 
    [bookmark: pgfId-7218525]Step 14 In the Address field, type the routed LAG interface’s IP address and subnet mask using CIDR notation. Note the following:
 
     
      
      	 [bookmark: pgfId-7218526]You cannot add network and broadcast addresses, or the static MAC addresses 00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF.
 
      	 [bookmark: pgfId-7218527]You cannot add identical IP addresses, regardless of subnet mask, to interfaces in virtual routers.
 
     
 
    
 
    [bookmark: pgfId-7218528]Step 15 Optionally, if your organization uses IPv6 addresses, next to the IPv6 field, select the Address Autoconfiguration check box to set the IP address of the LAG interface automatically.
 
    [bookmark: pgfId-7218529]Step 16 For Type, select either Normal or SFRP. 
 
    [bookmark: pgfId-7218533]For SFRP options, see Configuring SFRP for more information.
 
    [bookmark: pgfId-7218534]Step 17 Click OK.
 
    [bookmark: pgfId-7218535]The IP address is added.
 ). 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7218543]Note When adding an IP address to a routed interface of a clustered device, you must add a corresponding IP address to the routed interface on the cluster peer.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7218544]Step 18 To add a static ARP entry, click Add.
 
    [bookmark: pgfId-7218545]The Add Static ARP Entry pop-up window appears.
 
    [bookmark: pgfId-7218546]Step 19 In the IP Address field, type an IP address for the static ARP entry.
 
    [bookmark: pgfId-7218547]Step 20 In the MAC Address field, type a MAC address to associate with the IP address. Enter the address using the standard format of six groups of two hexadecimal digits separated by colons (for example, 01:23:45:67:89:AB).
 
    [bookmark: pgfId-7218548]Step 21 Click OK.
 
    [bookmark: pgfId-7218549]The static ARP entry is added.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7232704]Step 22 Under Link Aggregation, you have two options for selecting physical interfaces to add to the LAG bundle:
 
    
     
     	 [bookmark: pgfId-7232708]Next to  Available Interfaces , select one or more interfaces, then click the add selected icon (
 
    
 
    [image: ] ). Use 
     Ctrl or 
     Shift to select multiple physical interfaces. 
   
 
    
     
     	 [bookmark: pgfId-7232712]To add all interface pairs to the LAG bundle, click the add all icon (
 
    
 
    [image: ] ). 
   
 
    
     
   
 
   
 
   
 
   [bookmark: pgfId-7250217]Step 23 From the Load-Balancing Algorithm drop-down list, select the option that supports your deployment scenario. See Specifying a Load-Balancing Algorithm for more information.
 
   [bookmark: pgfId-7252659]Step 24 From the Link Selection Policy drop-down list, select the option that supports your deployment scenario: Highest Port Count (redundancy), Highest Total Bandwidth (speed), Stable (no excessive change in maintain link state), or LACP Priority (automatic link aggregation). 
 
   [bookmark: pgfId-7254112]If you select LACP Priority, you need to assign a value for System Priority. You then need to click the Configure Interface Priority link to assign a priority value for each interface in the LAG. You can specify 0 to 65535. If you do not specify a value, the default priority is 32768. See Specifying a Link Selection Policy for more information.
 
    
     
   
 
   
 
   [bookmark: pgfId-7272466]Note Select LACP Priority when you configure an aggregate interface between a FireSIGHT System device and a third-party network device.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-7266410]Step 25 From the Tunnel Level drop-down list, select the option that supports your deployment scenario, either Inner or Outer. 
 
   [bookmark: pgfId-7266411]Note that the tunnel level only applies to IPv4 traffic when Layer 3 load balancing is configured. The outer tunnel is always used for Layer 2 and IPv6 traffic. If the Tunnel Level is not explicitly set, the default is Outer. 
 
   [bookmark: pgfId-7266406]Step 26 Under LACP, select the Enabled check box to allow the switched LAG interface to handle traffic using the Link Aggregation Control Protocol. See Configuring LACP for more information.
 
   [bookmark: pgfId-7239537]If you clear the check box, the LAG interface becomes a static configuration and the FireSIGHT System will use all of the physical interfaces for the aggregation.
 
   [bookmark: pgfId-7240104]Step 27 Select a Rate radio button to set the frequency that determines how often LACP control messages are received from the partner device.
 
    
     
     	 [bookmark: pgfId-7240105]Select  Slow to receive packets every 30 seconds.
 
     	 [bookmark: pgfId-7240106]Select  Fast to receive packets every 1 second.
 
    
 
   
 
   [bookmark: pgfId-7240427]Step 28 Select a Mode radio button to establish the listening mode of the device.
 
    
     
     	 [bookmark: pgfId-7240428]Select  Active to initiate negotiations with remote links by sending LACP packets to the partner device.
 
     	 [bookmark: pgfId-7240429]Select  Passive to respond to LACP packets received. 
 
    
 
   
 
   [bookmark: pgfId-7240096]Step 29 Click Save.
 
   [bookmark: pgfId-7218558]The routed LAG interface is configured. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7239560]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7231108][bookmark: 19586]Adding Logical Aggregate Interfaces
 
    [bookmark: pgfId-7231115]License: Control
 
    [bookmark: pgfId-7231122]Supported Devices: Series 3
 
    [bookmark: pgfId-7246172]For each switched or routed aggregate interface, you can add multiple logical interfaces. You must associate each logical LAG interface with a VLAN tag to handle traffic received by the LAG interface with that specific tag. You add logical interfaces to switched or routed aggregate interfaces in the same way you would add them to physical switched or routed interfaces. 
 
     
      
    
 
    
 
    [bookmark: pgfId-7250855]Note When you create a LAG interface you also create an “untagged” logical interface by default, which is identified by the lagn.0 label, where n is an integer from 0 to 13. To be operational, each LAG requires this one logical interface at a minimum. You can associate additional logical interfaces with any LAG to handle VLAN-tagged traffic. Each additional logical interface requires a unique VLAN tag. The FireSIGHT system supports VLAN tags in the range of 1 through 4094. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7250435]You can also configure SFRP on a logical routed interface. See Configuring SFRP for more information.
 
    [bookmark: pgfId-7250436]Note that disabling the ICMP Enable Responses option for logical routed interfaces does not prevent ICMP responses in all scenarios. You can add rules to an access control policy to drop packets where the destination IP is the routed interface’s IP and the protocol is ICMP; see Controlling Traffic with Network-Based Rules. 
 
    [bookmark: pgfId-7258116]If you have enabled the Inspect Local Router Traffic option on the managed device, it drops the packets before they reach the host, thereby preventing any response. For more information about inspecting local router traffic, see Understanding Advanced Device Settings.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7274832] 
     Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 ) next to the interface. 
    
 
    [bookmark: pgfId-7250583]To add a logical LAG interface:
 
    [bookmark: pgfId-7250587]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7250588]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7250589]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7250594]The Interfaces tab appears.
 
    [bookmark: pgfId-7250596]Step 3 From the Add drop-down menu, select Add Logical Interface.
 
    [bookmark: pgfId-7250701]The Add Interface pop-up window appears.
 
    [bookmark: pgfId-7250702]Step 4 Click Switched to display the switched interface options, or select Routed to display the routed interface options.
 
    [bookmark: pgfId-7250732]When you create a logical interface for a LAG, you select an available LAG from the Interface drop-down list. The aggregate interface is identified by the lagn label, where n is an integer from 0 to 13.
 
    [bookmark: pgfId-7250815]See Adding Logical Switched Interfaces for more information on adding a logical interface to a switched interface. 
 
    [bookmark: pgfId-7250812]See Adding Logical Routed Interfaces for more information on adding a logical interface to a routed interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-7270262]Note When an aggregate interface is disabled, the logical interface associated with the aggregate interface is also disabled.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7270546]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7270579][bookmark: 24294]Viewing Aggregate Interface Statistics
 
    [bookmark: pgfId-7270586]License: Control
 
    [bookmark: pgfId-7270593]Supported Devices: Series 3
 
    [bookmark: pgfId-7271667]You can view protocol and traffic statistics for each aggregate interface. The statistics show LACP protocol information such as LACP key and partner information, packets received, packets transmitter, and packets dropped. Statistics are further refined per member interface to show traffic and link information on a per-port basis.
 
    [bookmark: pgfId-7272744]Aggregate interface information is also presented to the dashboard via predefined dashboard widgets. The Current Interface Status widget shows the status of all interfaces on the appliance, enabled or unused. The Interface Traffic widget shows the rate of traffic received (Rx) and transmitted (Tx) on the appliance’s interfaces over the dashboard time range. See Understanding the Predefined Widgets.
 
    [bookmark: pgfId-7271669]To view aggregate interface statistics:
 
    [bookmark: pgfId-7270599]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7270600]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7270601]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7272193]The Interfaces tab for that device appears.
 ). 
    
 
    [bookmark: pgfId-7272198]The Statistics pop-up window appears.
 
    [bookmark: pgfId-7270549]Step 4 Click OK to close the window.
 
    [bookmark: pgfId-7273409]
 
     
     
 
    
 
    [bookmark: 44760] 
    
 
   
 
    
     [bookmark: pgfId-7270569][bookmark: 93275]Deleting Aggregate Interf[bookmark: marker-7270548]aces
 
    [bookmark: pgfId-7270556]License: Control
 
    [bookmark: pgfId-7209852]Supported Devices: Series 3
 
    [bookmark: pgfId-7199452]The following procedure explains how to delete an aggregate interface.
 
    [bookmark: pgfId-7199453]To delete an aggregate interface:
 
    [bookmark: pgfId-7198433]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7198434]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7198435]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7198440]The Interfaces tab for that device appears.
 ). 
    
 
    [bookmark: pgfId-7245828]The aggregate interface can be identified by the lagn label, where n can be an integer from 0 to 13.
 
    [bookmark: pgfId-7198445]Step 4 When prompted, confirm that you want to delete the aggregate interface.
 
    [bookmark: pgfId-7246035]The interface is deleted. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7246039]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7243321]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-6753877]Setting [bookmark: Setting Up Hybrid Interfaces]Up Hyb[bookmark: marker-7201413]rid Interfaces 
      
      
 
     
 
 
    [bookmark: pgfId-7190777]You can configure logical hybrid interfaces on managed devices that allow the FireSIGHT System to bridge traffic between virtual routers and virtual switches. If IP traffic received on interfaces in a virtual switch is addressed to the MAC address of an associated hybrid logical interface, the system handles it as Layer 3 traffic and either routes or responds to the traffic depending on the destination IP address. If the system receives any other traffic, it handles it as Layer 2 traffic and switches it appropriately. You cannot configure logical hybrid interfaces on a virtual managed device or Cisco NGIPS for Blue Coat X-Series.
 
    [bookmark: pgfId-7200366]For more information about setting up hybrid interfaces, see Adding Logical Hybrid Interfaces.
 
   
 
    
     [bookmark: pgfId-7199504][bookmark: 19983]Adding Log[bookmark: marker-7201418]ical Hybrid Interfaces
 
    [bookmark: pgfId-7199506]License: Control
 
    [bookmark: pgfId-7209836]Supported Devices: Series 3
 
    [bookmark: pgfId-7199507]You must associate a logical hybrid interface with a virtual router and virtual switch to bridge traffic between Layer 2 and Layer 3. You can only associate a single hybrid interface with a virtual switch. However, you can associate multiple hybrid interfaces with a virtual router.
 
    [bookmark: pgfId-7202197]You can also configure SFRP on a logical hybrid interface. See Configuring SFRP for more information.
 
    [bookmark: pgfId-7203308]Note that disabling the ICMP Enable Responses option for hybrid interfaces does not prevent ICMP responses in all scenarios. You can add rules to an access control policy to drop packets where the destination IP is the hybrid interface’s IP and the protocol is ICMP; see Controlling Traffic with Network-Based Rules.
 
    [bookmark: pgfId-7218537]If you have enabled the Inspect Local Router Traffic option on the managed device, it drops the packets before they reach the host, thereby preventing any response. For more information about inspecting local router traffic, see Understanding Advanced Device Settings.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7220503] 
     Caution Changing any (Series 2) or the highest (Series 3) MTU value for a sensing interface or inline set temporarily interrupts traffic inspection on all sensing interfaces on the device, not just the interface you changed, when you apply your changes. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and the interface type. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 ) next to the interface. 
    
 
    [bookmark: pgfId-7198105]To add a logical hybrid interface:
 
    [bookmark: pgfId-7198106]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7198107]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7198108]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7213680]The Interfaces tab appears.
 
    [bookmark: pgfId-7218273]Step 3 From the Add drop-down menu, select Add Logical Interface.
 
    [bookmark: pgfId-7218274]The Add Interface pop-up window appears.
 
    [bookmark: pgfId-7218275]Step 4 Click Hybrid to display the hybrid interface options.
 
    [bookmark: pgfId-7198401]Step 5 In the Name field, type a name for the interface. You can use alphanumeric characters and spaces.
 
    [bookmark: pgfId-7198403]Step 6 From the Virtual Router drop-down list, select an existing virtual router, select None, or select New to add a new virtual router.
 
    [bookmark: pgfId-7198126]Note that if you add a new virtual router, you must configure it on the Device Management page (Devices > Device Management> Virtual Routers) after you finish setting up the hybrid interface. See Adding Virtual Routers.
 
    [bookmark: pgfId-7198281]Step 7 From the Virtual Switch drop-down list, select an existing virtual switch, select None, or select New to add a new virtual switch.
 
    [bookmark: pgfId-7198297]Note that if you add a new virtual switch, you must configure it on the Device Management page (Devices > Device Management> Virtual Switches) after you finish setting up the hybrid interface. See Adding Virtual Switches.
 
    [bookmark: pgfId-7198274]Step 8 Select the Enabled check box to allow the hybrid interface to handle traffic.
 
    [bookmark: pgfId-7198131]If you clear the check box, the interface becomes disabled and administratively taken down.
 
    [bookmark: pgfId-7201124]Step 9 In the MTU field, type a maximum transmission unit (MTU), which designates the largest size packet allowed.
 
    [bookmark: pgfId-7208410]The range within which you can set the MTU can vary depending on the FireSIGHT System device model and the interface type. See MTU Ranges for Managed Devices for more information.
 
    [bookmark: pgfId-7208411]Step 10 Next to ICMP, select the Enable Responses check box to allow the interface to respond to ICMP traffic such as pings and traceroute.
 
    [bookmark: pgfId-7201126]Step 11 Next to IPv6 NDP, select the Enable Router Advertisement check box to enable the interface to broadcast router advertisements.
 
    [bookmark: pgfId-7201130]You can only select this option if you added IPv6 addresses.
 
    [bookmark: pgfId-7198135]Step 12 To add an IP address, click Add.
 
    [bookmark: pgfId-7198136]The Add IP Address pop-up window appears.
 
    [bookmark: pgfId-7212178]Step 13 In the Address field, type the IP address and subnet mask. Note the following:
 
     
      
      	 [bookmark: pgfId-7212188]You cannot add network and broadcast addresses, or the static MAC addresses 00:00:00:00:00:00 and FF:FF:FF:FF:FF:FF.
 
      	 [bookmark: pgfId-7212179]You cannot add identical IP addresses, regardless of subnet mask, to interfaces in virtual routers.
 
     
 
    
 
    [bookmark: pgfId-7198138]Step 14 Optionally if you have IPv6 addresses, next to the IPv6 field, select the Address Autoconfiguration check box to set the IP address of the interface automatically.
 
    [bookmark: pgfId-7198139]Step 15 For Type, select either Normal or SFRP. 
 
    [bookmark: pgfId-7202413]For SFRP options, see Configuring SFRP for more information.
 
    [bookmark: pgfId-7198145]Step 16 Click OK.
 
    [bookmark: pgfId-7198146]The IP address is added.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7198167]Step 17 Click Save.
 
   [bookmark: pgfId-7198168]The logical hybrid interface is added. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
   [bookmark: pgfId-7216505]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7198429][bookmark: 68587]Deleting Logical Hybrid Interf[bookmark: marker-7201446]aces
 
    [bookmark: pgfId-7199451]License: Control
 
    [bookmark: pgfId-7209852]Supported Devices: Series 3
 
    [bookmark: pgfId-7199452]The following procedure explains how to delete a logical hybrid interface.
 
    [bookmark: pgfId-7199453]To delete a hybrid interface:
 
    [bookmark: pgfId-7198433]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7198434]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-7198435]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-7198440]The Interfaces tab for that device appears.
 ). 
    
 
    [bookmark: pgfId-7198445]Step 4 When prompted, confirm that you want to delete the interface.
 
    [bookmark: pgfId-7198540]The interface is deleted. Note that your changes do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-7216519]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7214088]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7287786]Using Gateway [bookmark: marker-7316646]VPNs 
      
      
 
     
 
 
    [bookmark: pgfId-7287787]A virtual private network (VPN) is a network connection that establishes a secure tunnel between endpoints via a public source, such as the Internet or other network. You can configure the FireSIGHT System to build secure VPN tunnels between the virtual routers of Cisco managed devices. The system builds tunnels using the Internet Protocol Security (IPSec) protocol suite.
 
    [bookmark: pgfId-7295086]Only Cisco managed devices can be used as endpoints in Cisco VPN deployments. Third-party endpoints are not supported.
 
    [bookmark: pgfId-7234522]After the VPN connection is established, the hosts behind the local gateway can connect to the hosts behind the remote gateway through the secure VPN tunnel. A connection consists of the IP addresses and host names of the two gateways, the subnets behind them, and the shared secrets for the two gateways to authenticate to each other.
 
    [bookmark: pgfId-7230718]The VPN endpoints authenticate to each other with either the Internet Key Exchange (IKE) version 1 or version 2 protocol to create a security association for the tunnel. The system uses either the IPSec authentication header (AH) protocol or the IPSec encapsulating security payload (ESP) protocol to authenticate the data entering the tunnel. The ESP protocol encrypts the data as well as providing the same functionality as AH.
 
    [bookmark: pgfId-7280079]If you have access control policies in your deployment, the system does not send VPN traffic until it has passed through access control. In addition, the system does not send tunnel traffic to the public source when the tunnel is down.
 
    [bookmark: pgfId-7249907]To configure and apply VPN deployments, you must have a VPN license enabled on each of your target managed devices. Additionally, VPN features are only available on Series 3 devices.
 
    [bookmark: pgfId-7217661]See the following sections for more information on creating and managing VPN deployments:
 
     
     	 [bookmark: pgfId-7217665]Understanding IPSec
 
     	 [bookmark: pgfId-7217673]Understanding VPN Deployments
 
     	 [bookmark: pgfId-7217677]Managing VPN Deployments
 
    
 
   
 
    
     [bookmark: pgfId-7214994][bookmark: 10412]Understanding I[bookmark: marker-7287805]PSec
 
    [bookmark: pgfId-7215154]The IPSec protocol suite defines how IP packets across a VPN tunnel are hashed, encrypted, and encapsulated in the ESP or AH security protocol. The FireSIGHT System uses the hash algorithm and encryption key of the Security Association (SA), which becomes established between the two gateways by the Internet Key Exchange (IKE) protocol.
 
    [bookmark: pgfId-7269381]Security associations (SA) establish shared security attributes between two devices and allow VPN endpoints to support secure communication. An SA allows two VPN endpoints to handle the parameters for how the VPN tunnel is secured between them.
 
    [bookmark: pgfId-7250768]The system uses the Internet Security Association and Key Management Protocol (ISAKMP) during the initial phase of negotiating the IPSec connection to establish the VPN between endpoints and the authenticated key exchange. The IKE protocol resides within ISAKMP. See Understanding IKE for more information about the IKE protocol.
 
    [bookmark: pgfId-7251766]The AH security protocol provides protection for packet headers and data, but it cannot encrypt them. ESP provides encryption and protection for packets, but it cannot secure the outermost IP header. In many cases, this protection is not required, and most VPN deployments use ESP more frequently than AH because of its encryption capabilities. Since VPN only operates in tunnel mode, the system encrypts and authenticates the entire packet from Layer 3 and up in the ESP protocol. ESP in tunnel mode encrypts the data as well as providing the latter’s encryption capabilities.
 
     
      [bookmark: pgfId-7212424][bookmark: 38466]Understanding I[bookmark: marker-7287814]KE
 
     [bookmark: pgfId-7215363]The FireSIGHT System uses the IKE protocol to mutually authenticate the two gateways against each other as well as to negotiate the SA for the tunnel. The process consists of two phases.
 
     [bookmark: pgfId-7269854]IKE phase 1 establishes a secure authenticated communication channel by using the Diffie-Hellman key exchange to generate a pre-shared key to encrypt further IKE communications. This negotiation results in a bidirectional ISAKMP security association. The system allows you to perform the authentication using a pre-shared key. Phase 1 operates in main mode, which seeks to protect all data during the negotiation, while also protecting the identity of the peers.
 
     [bookmark: pgfId-7230535]During IKE phase 2, the IKE peers use the secure channel established in phase 1 to negotiate security associations on behalf of IPSec. The negotiation results in a minimum of two unidirectional security associations, one inbound and one outbound.
 
    
 
   
 
    
     [bookmark: pgfId-7214918][bookmark: 63270]Understanding V[bookmark: marker-7287826]PN Deployments
 
    [bookmark: pgfId-7292974]A VPN deployment specifies the endpoints and networks that are included in a VPN and how they connect to each other. After you configure a VPN deployment, you can then apply it to your managed devices or devices managed by another Defense Center.
 
    [bookmark: pgfId-7266152]The system supports three types of VPN deployments: point-to-point, star, and mesh. See the following sections for more information about these VPN deployments:
 
     
     	 [bookmark: pgfId-7266362]Understanding Point-to-Point VPN Deployments
 
     	 [bookmark: pgfId-7266384]Understanding Star VPN Deployments
 
     	 [bookmark: pgfId-7266394]Understanding Mesh VPN Deployments
 
    
 
     
      [bookmark: pgfId-7246161][bookmark: 66086]Understanding Point-to-Point V[bookmark: marker-7287848]PN Deployments
 
     [bookmark: pgfId-7246221]In a point-to-point VPN deployment, two endpoints communicate directly with each other. You configure the two endpoints as peer devices, and either device can initiate the secured connection. Each of the devices in this configuration must be a VPN-enabled managed device.
 
     [bookmark: pgfId-7262132]The following diagram displays a typical point-to-point VPN deployment.
 
     [bookmark: pgfId-7321079]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7261381]See Configuring Point-to-Point VPN Deployments for more information.
 
    
 
     
      [bookmark: pgfId-7267064][bookmark: 84594]Understanding Star V[bookmark: marker-7287919]PN Deployments
 
     [bookmark: pgfId-7261209]In a star VPN deployment, a central endpoint (hub node) establishes a secure connection with multiple remote endpoints (leaf nodes). Each connection between the hub node and an individual leaf node is a separate VPN tunnel. The hosts behind any of the leaf nodes can communicate with each other through the hub node.
 
     [bookmark: pgfId-7261188]Star deployments commonly represent a VPN that connects an organization’s main and branch office locations using secure connections over the Internet or other third-party network. Star VPN deployments provide all employees with controlled access to the organization’s network.
 
     [bookmark: pgfId-7261112]In a typical star deployment, the hub node is located at the main office. Leaf nodes are located at branch offices and initiate most of the traffic. Each of the nodes must be a VPN-enabled managed device. 
 
     [bookmark: pgfId-7295069]Note that star deployments only support IKE version 2.
 
     [bookmark: pgfId-7253726]The following diagram displays a typical star VPN deployment.
 
     [bookmark: pgfId-7321103]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7266777]See Configuring Star VPN Deployments for more information.
 
    
 
     
      [bookmark: pgfId-7267025][bookmark: 21756]Understanding Mesh V[bookmark: marker-7287966]PN Deployments
 
     [bookmark: pgfId-7295209]In a mesh VPN deployment, all endpoints can communicate with every other endpoint by means of an individual VPN tunnel. The mesh deployment offers redundancy so that when one endpoint fails, the remaining endpoints can still communicate with each other. This type of deployment commonly represents a VPN that connects a group of decentralized branch office locations. The number of VPN-enabled managed devices you deploy in this configuration depends on the level of redundancy you require. Each of the endpoints must be a VPN-enabled managed device.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-7267494]See Configuring Mesh VPN Deployments for more information.
 
    
 
   
 
    
     [bookmark: pgfId-7267285][bookmark: 98705]Managing V[bookmark: marker-7288078]PN Deployments
 
    [bookmark: pgfId-7303897]License: VPN
 
    [bookmark: pgfId-7303901]Supported Devices: Series 3
 
    [bookmark: pgfId-7283358]On the VPN page (Devices > VPN) you can view all of your current VPN deployments by name and the endpoints contained in the deployment. Options on this page allow you to view the status of a VPN deployment, create a new deployment, apply a deployment, and edit or delete a deployment.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7283359] 
     Caution If you select the default access control policy when registering a device to your Defense Center, the default access control rule blocks all traffic. If you configure a VPN deployment on the device, the deployment fails. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7216724]Note that when you register a device to a Defense Center, applied VPN deployments sync to the Defense Center during registration. 
 
    [bookmark: pgfId-7295788]The following table describes the actions you can take to manage your deployments on the VPN page.
 
    [bookmark: pgfId-7216851]
 
     
     Configuring VPN Deployments 
     
 
     Applying a VPN Deployment 
     
 
     
 
      
       
       [bookmark: pgfId-7216783]Table 10-1 VPN Deployment Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-7216787]To... 
         
  
        	 
          
          [bookmark: pgfId-7216789]You can... 
         
  
       
 
        
        	[bookmark: pgfId-7216791]create a new VPN deployment
  
        	[bookmark: pgfId-7216795]click Add. See Configuring VPN Deployments for more information.
  
       
 
        
        	[bookmark: pgfId-7216798]modify the settings in an existing VPN deployment
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-7217049]view the status of an existing VPN deployment
  
        	[bookmark: pgfId-7217051]click the status icon. See Viewing VPN Deployment Status for more information.
  
       
 
        
        	[bookmark: pgfId-7216808]apply a VPN deployment to all devices targeted in the deployment
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-7216845]delete a VPN deployment
  if you decide not to delete the deployment. 
       
 
       
     
 
    
 
     
      [bookmark: pgfId-7217338][bookmark: 58348]Configuring V[bookmark: marker-7288101]PN Deployments
 
     [bookmark: pgfId-7217380]License: VPN
 
     [bookmark: pgfId-7244358]Supported Devices: Series 3
 
     [bookmark: pgfId-7217466]When you create a new VPN deployment you must, at minimum, give it a unique name, specify a deployment type, and designate a pre-shared key. You can select from three types of deployment, each containing a group of VPN tunnels:
 
      
      	 [bookmark: pgfId-7217467]Point-to-point (PTP) deployments establish a VPN tunnel between two endpoints.
 
      	 [bookmark: pgfId-7217468]Star deployments establish a group of VPN tunnels connecting a hub endpoint to a group of leaf endpoints.
 
      	 [bookmark: pgfId-7217504]Mesh deployments establish a group of VPN tunnels among a set of endpoints.
 
     
 
     [bookmark: pgfId-7294956]Only Cisco managed devices can be used as endpoints in Cisco VPN deployments. Third-party endpoints are not supported.
 
     [bookmark: pgfId-7294970]You must define a pre-shared key for VPN authentication. You can specify a default key to use in all of the VPN connections you generate in a deployment. For point-to-point deployments, you can specify a pre-shared key for each endpoint pair.
 
     [bookmark: pgfId-7294957]See the following sections for more information on creating each type of VPN deployment:
 
      
      	 [bookmark: pgfId-7218109]Configuring Point-to-Point VPN Deployments
 
      	 [bookmark: pgfId-7218113]Configuring Star VPN Deployments
 
      	 [bookmark: pgfId-7218117]Configuring Mesh VPN Deployments
 
     
 
    
 
     
      [bookmark: pgfId-7218096][bookmark: 24193]Configuring Point-to-Point VPN Deployments
 
     [bookmark: pgfId-7218097]License: VPN
 
     [bookmark: pgfId-7245057]Supported Devices: Series 3
 
     [bookmark: pgfId-7217524]When configuring a point-to-point VPN deployment, you define a group of endpoint pairs and then create a VPN between the two nodes in each pair. For more information, see Understanding Point-to-Point VPN Deployments.
 
     [bookmark: pgfId-7224650]The following list describes the options you can specify in your deployment.
 
     [bookmark: pgfId-7224659]Name
 
     [bookmark: pgfId-7224670]Give the deployment a unique name.
 
     [bookmark: pgfId-7224786]Type
 
     [bookmark: pgfId-7224792]Click PTP to specify that you are configuring a point-to-point deployment.
 
     [bookmark: pgfId-7224651]Pre-shared Key
 
     [bookmark: pgfId-7224652]Define a unique pre-shared key for authentication. The system uses this key for all the VPNs in your deployment, unless you specify a pre-shared key for each endpoint pair.
 
     [bookmark: pgfId-7224601]Device
 
     [bookmark: pgfId-7224602]You can select a managed device, including a device stack or cluster, as an endpoint for your deployment. For Cisco managed devices not managed by the Defense Center you are using, select Other and then specify an IP address for the endpoint.
 
     [bookmark: pgfId-7221311]Virtual Router
 
     [bookmark: pgfId-7221327]If you selected a managed device as your endpoint, select a virtual router that is currently applied to the selected device. You cannot select the same virtual router for more than one endpoint.
 
     [bookmark: pgfId-7221329]Interface
 
     [bookmark: pgfId-7221340]If you selected a managed device as your endpoint, select a routed interface that is assigned to the selected virtual router. 
 
     [bookmark: pgfId-7221353]IP Address
 
     [bookmark: pgfId-7221368] – If you selected a managed device as an endpoint, select an IP address that is assigned to the selected routed interface.
 
     [bookmark: pgfId-7285234] – If the managed device is a device cluster, you can only select from a list SFRP IP addresses.
 
     [bookmark: pgfId-7294915] – If you selected a managed device not managed by the Defense Center, specify an IP address for the endpoint.
 
     [bookmark: pgfId-7226095]Protected Networks
 
     [bookmark: pgfId-7287600]Specify the networks in your deployment that are encrypted. Enter a subnet with CIDR block for each network. IKE version 1 only supports a single protected network.
 
     [bookmark: pgfId-7295115]Note that VPN endpoints cannot have the same IP address and that protected networks in a VPN endpoint pair cannot overlap. If a list of protected networks for an endpoint contains one or more IPv4 or IPv6 entry, the other endpoint's protected network must have at least one entry of the same type (i.e., IPv4 or IPv6). If it does not, then the other endpoint's IP address must be of the same type and must not overlap with the entries in the protected network. (Use /32 CIDR address blocks for IPv4 and /128 CIDR address blocks for IPv6). If both of these checks fail, the endpoint pair is invalid.
 
     [bookmark: pgfId-7287601]Internal IP
 
     [bookmark: pgfId-7221414]Select the check box if the endpoint resides behind a firewall with network address translation.
 
     [bookmark: pgfId-7225776]Public IP
 
     [bookmark: pgfId-7225777]If you selected Internal IP, specify a public IP address for the firewall. If the endpoint is a responder, you must specify this value.
 
     [bookmark: pgfId-7295373]Public IKE Port
 
     [bookmark: pgfId-7295374]If you selected Internal IP, specify a single numerical value from 1 to 65535 for the UDP port on the firewall that is being port-forwarded to the internal endpoint. If the endpoint is a responder and the port on the firewall being forwarded is not 500 or 4500, you must specify this value.
 
     [bookmark: pgfId-7295375]Use Deployment Key
 
     [bookmark: pgfId-7221471]Select the check box to use the pre-shared key defined for the deployment. Clear the check box to specify a pre-shared key for VPN authentication for this endpoint pair.
 
     [bookmark: pgfId-7221473]Pre-shared Key
 
     [bookmark: pgfId-7221489]If you cleared the Use Deployment Key check box, specify a pre-shared key in this field.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-7283438]To configure a point-to-point VPN deployment:
 
    [bookmark: pgfId-7283416]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7211808]Step 1 Select Devices > VPN.
 
    [bookmark: pgfId-7212115]The VPN page appears.
 
    [bookmark: pgfId-7212148]Step 2 Click Add.
 
    [bookmark: pgfId-7219067]The Create New VPN Deployment pop-up window appears.
 
    [bookmark: pgfId-7219069]Step 3 Give the deployment a unique Name.
 
    [bookmark: pgfId-7219177]You can use all printable characters, including spaces and special characters.
 
    [bookmark: pgfId-7219261]Step 4 Ensure that PTP is selected as the Type.
 
    [bookmark: pgfId-7219299]Step 5 Give the deployment a unique Pre-shared Key.
 ). 
    
 
    [bookmark: pgfId-7219487]The Add New Endpoint Pair pop-up window appears.
 
    [bookmark: pgfId-7219537]Step 7 Configure the VPN deployment, as described earlier in this section.
 ). 
    
 
    [bookmark: pgfId-7219696]The Add Network pop-up window appears.
 
    [bookmark: pgfId-7221686]Step 9 Type a CIDR block for the protected network.
 
    [bookmark: pgfId-7219698]Step 10 [bookmark: 86997]Click OK.
 
    [bookmark: pgfId-7221762]The protected network is added.
 
    [bookmark: pgfId-7221809]Step 11 Repeat step 8 through step 10 for Node B.
 
    [bookmark: pgfId-7219774]Step 12 Click Save.
 
    [bookmark: pgfId-7219844]The endpoint pair is added to your deployment and the Create New VPN Deployment pop-up window appears again.
 
    [bookmark: pgfId-7219846]Step 13 Click Save to finish configuring your deployment and the VPN page appears again.
 
    [bookmark: pgfId-7219890]Note that you must apply the deployment for it to take effect; see Applying a VPN Deployment.
 
    [bookmark: pgfId-7306508]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7219072][bookmark: 50210]Configuring Star VPN Deployments
 
    [bookmark: pgfId-7211618]License: VPN
 
    [bookmark: pgfId-7245017]Supported Devices: Series 3
 
    [bookmark: pgfId-7217587]When configuring a star VPN deployment, you define a single hub node endpoint and a group of leaf node endpoints. You must define the hub node endpoint and at least one leaf node endpoint to configure the deployment. For more information, see Understanding Star VPN Deployments.
 
    [bookmark: pgfId-7226918]The following list describes the options you can specify in your deployment.
 
    [bookmark: pgfId-7226919]Name
 
    [bookmark: pgfId-7226920]Give the deployment a unique name.
 
    [bookmark: pgfId-7226921]Type
 
    [bookmark: pgfId-7226922]Click Star to specify that you are configuring a star deployment.
 
    [bookmark: pgfId-7226923]Pre-shared Key
 
    [bookmark: pgfId-7226924]Define a unique pre-shared key for authentication.
 
    [bookmark: pgfId-7226925]Device
 
    [bookmark: pgfId-7226926]You can select a managed device, including a device stack or cluster, as an endpoint for your deployment. For Cisco managed devices not managed by the Defense Center you are using, select Other and then specify an IP address for the endpoint.
 
    [bookmark: pgfId-7226930]Virtual Router
 
    [bookmark: pgfId-7226931]If you selected a managed device as your endpoint, select a virtual router that is currently applied to the selected device. You cannot select the same virtual router for more than one endpoint.
 
    [bookmark: pgfId-7226932]Interface
 
    [bookmark: pgfId-7226933]If you selected a managed device as your endpoint, select a routed interface that is assigned to the selected virtual router.
 
    [bookmark: pgfId-7226934]IP Address
 
    [bookmark: pgfId-7243529] – If you selected a managed device as an endpoint, select an IP address that is assigned to the selected routed interface.
 
    [bookmark: pgfId-7286989] – If the managed device is a device cluster, you can only select from a list SFRP IP addresses.
 
    [bookmark: pgfId-7294509] – If you selected a managed device not managed by the Defense Center, specify an IP address for the endpoint.
 
    [bookmark: pgfId-7226941]Protected Networks
 
    [bookmark: pgfId-7226942]Specify the networks in your deployment that are encrypted. Enter a subnet with CIDR block for each network.
 
    [bookmark: pgfId-7295302]Note that VPN endpoints cannot have the same IP address and that protected networks in a VPN endpoint pair cannot overlap. If a list of protected networks for an endpoint contains one or more IPv4 or IPv6 entry, the other endpoint's protected network must have at least one entry of the same type (i.e., IPv4 or IPv6). If it does not, then the other endpoint's IP address must be of the same type and must not overlap with the entries in the protected network. (Use /32 CIDR address blocks for IPv4 and /128 CIDR address blocks for IPv6). If both of these checks fail, the endpoint pair is invalid.
 
    [bookmark: pgfId-7233674]Internal IP
 
    [bookmark: pgfId-7233675]Select the check box if the endpoint resides behind a firewall with network address translation.
 
    [bookmark: pgfId-7233676]Public IP
 
    [bookmark: pgfId-7233677]If you selected Internal IP, specify a public IP address for the firewall. If the endpoint is a responder, you must specify this value.
 
    [bookmark: pgfId-7233678]Public IKE Port
 
    [bookmark: pgfId-7245547]If you selected Internal IP, specify a single numerical value from 1 to 65535 for the UDP port on the firewall that is being port-forwarded to the internal endpoint. If the endpoint is a responder and the port on the firewall being forwarded is not 500 or 4500, you must specify this value.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7211819]To configure a star deployment:
 
   [bookmark: pgfId-7211834]Access: Admin/Network Admin
 
   
 
   [bookmark: pgfId-7212293]Step 1 Select Devices > VPN.
 
   [bookmark: pgfId-7212284]The VPN page appears
 
   [bookmark: pgfId-7220261]Step 2 Click Add.
 
   [bookmark: pgfId-7220291]The Create New VPN Deployment pop-up window appears.
 
   [bookmark: pgfId-7220567]Step 3 Give the deployment a unique Name.
 
   [bookmark: pgfId-7224172]You can use all printable characters, including spaces and special characters.
 
   [bookmark: pgfId-7224175]Step 4 Click Star to specify the Type.
 
   [bookmark: pgfId-7224176]Step 5 Give the deployment a unique Pre-shared Key.
 ). 
   
 
   [bookmark: pgfId-7220070]The Add Hub Node pop-up window appears.
 
   [bookmark: pgfId-7220071]Step 7 [bookmark: 66227]Configure the VPN deployment, as described earlier in this section.
 ). 
   
 
   [bookmark: pgfId-7227341]The Add Network pop-up window appears.
 
   [bookmark: pgfId-7227342]Step 9 Type an IP address for the protected network.
 
   [bookmark: pgfId-7227344]Step 10 [bookmark: 20344]Click OK.
 
   [bookmark: pgfId-7227328]The protected network is added.
 
   [bookmark: pgfId-7227512]Step 11 [bookmark: 80787]Click Save.
 
   [bookmark: pgfId-7227534]The hub node is added to your deployment and the Create New VPN Deployment pop-up window appears again.
 ). 
   
 
   [bookmark: pgfId-7227392]The Add Leaf Node pop-up window appears.
 
   [bookmark: pgfId-7227584]Step 13 Repeat step 7 through step 10 to complete the leaf node, which has the same options as the hub node.
 
   [bookmark: pgfId-7227585]Step 14 Click Save.
 
   [bookmark: pgfId-7227586]The leaf node is added to your deployment and the Create New VPN Deployment pop-up window appears again.
 
   [bookmark: pgfId-7227587]Step 15 Click Save to finish configuring your deployment and the VPN page appears again.
 
   [bookmark: pgfId-7286060]Note that you must apply the deployment for it to take effect; see Applying a VPN Deployment.
 
   [bookmark: pgfId-7306599]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7211627][bookmark: 10138]Configuring Mesh VPN Deployments
 
    [bookmark: pgfId-7211662]License: VPN
 
    [bookmark: pgfId-7244987]Supported Devices: Series 3
 
    [bookmark: pgfId-7227762]When configuring a mesh VPN deployment, you define a group of VPNs to link any two points for a given set of endpoints. For more information, see Understanding Mesh VPN Deployments.
 
    [bookmark: pgfId-7227763]The following list describes the options you can specify in your deployment.
 
    [bookmark: pgfId-7227764]Name
 
    [bookmark: pgfId-7227765]Give the deployment a unique name.
 
    [bookmark: pgfId-7227766]Type
 
    [bookmark: pgfId-7227767]Click Mesh to specify that you are configuring a mesh deployment.
 
    [bookmark: pgfId-7227768]Pre-shared Key
 
    [bookmark: pgfId-7227769]Define a unique pre-shared key for authentication.
 
    [bookmark: pgfId-7227770]Device
 
    [bookmark: pgfId-7227771]You can select a managed device, including a device stack or cluster, as an endpoint for your deployment. For Cisco managed devices not managed by the Defense Center you are using, select Other and then specify an IP address for the endpoint.
 
    [bookmark: pgfId-7227775]Virtual Router
 
    [bookmark: pgfId-7227776]If you selected a managed device as your endpoint, select a virtual router that is currently applied to the selected device. You cannot select the same virtual router for more than one endpoint.
 
    [bookmark: pgfId-7227777]Interface
 
    [bookmark: pgfId-7227778]If you selected a managed device as your endpoint, select a routed interface that is assigned to the selected virtual router.
 
    [bookmark: pgfId-7227779]IP Address
 
    [bookmark: pgfId-7227780] – If you selected a managed device as an endpoint, select an IP address that is assigned to the selected routed interface.
 
    [bookmark: pgfId-7287007] – If the managed device is a device cluster, you can only select from a list SFRP IP addresses.
 
    [bookmark: pgfId-7287010] – If you selected a managed device not managed by the Defense Center, specify an IP address for the endpoint.
 
    [bookmark: pgfId-7227786]Protected Networks
 
    [bookmark: pgfId-7227787]Specify the networks in your deployment that are encrypted. Enter a subnet with CIDR block for each network. IKE version 1 only supports a single protected network.
 
    [bookmark: pgfId-7295329]Note that VPN endpoints cannot have the same IP address and that protected networks in a VPN endpoint pair cannot overlap. If a list of protected networks for an endpoint contains one or more IPv4 or IPv6 entry, the other endpoint's protected network must have at least one entry of the same type (i.e., IPv4 or IPv6). If it does not, then the other endpoint's IP address must be of the same type and must not overlap with the entries in the protected network. (Use /32 CIDR address blocks for IPv4 and /128 CIDR address blocks for IPv6). If both of these checks fail, the endpoint pair is invalid.
 
    [bookmark: pgfId-7233724]Internal IP
 
    [bookmark: pgfId-7233725]Select the check box if the endpoint resides behind a firewall with network address translation.
 
    [bookmark: pgfId-7233726]Public IP
 
    [bookmark: pgfId-7233727]If you selected Internal IP, specify a public IP address for the firewall. If the endpoint is a responder, you must specify this value.
 
    [bookmark: pgfId-7233728]Public IKE Port
 
    [bookmark: pgfId-7233729]If you selected Internal IP, specify a single numerical value from 1 to 65535 for the UDP port on the firewall that is being port-forwarded to the internal endpoint. If the endpoint is a responder and the port on the firewall being forwarded is not 500 or 4500, you must specify this value.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7211916]To configure a mesh VPN deployment:
 
   [bookmark: pgfId-7212228]Access: Admin/Network Admin
 
   
 
   [bookmark: pgfId-7228318]Step 1 Select Devices > VPN.
 
   [bookmark: pgfId-7228319]The VPN page appears
 
   [bookmark: pgfId-7228320]Step 2 Click Add.
 
   [bookmark: pgfId-7228321]The Create New VPN Deployment pop-up window appears.
 
   [bookmark: pgfId-7228322]Step 3 Give the deployment a unique Name.
 
   [bookmark: pgfId-7228323]You can use all printable characters, including spaces and special characters.
 
   [bookmark: pgfId-7228324]Step 4 Click Mesh to specify the Type.
 
   [bookmark: pgfId-7228325]Step 5 Give the deployment a unique Pre-shared Key.
 ). 
   
 
   [bookmark: pgfId-7228330]The Add Endpoint pop-up window appears.
 
   [bookmark: pgfId-7228336]Step 7 Configure the VPN deployment, as described earlier in this section.
 ). 
   
 
   [bookmark: pgfId-7228341]The Add Network pop-up window appears.
 
   [bookmark: pgfId-7228342]Step 9 Type a CIDR block for the protected network.
 
   [bookmark: pgfId-7228344]Step 10 Click OK.
 
   [bookmark: pgfId-7228345]The protected network is added.
 
   [bookmark: pgfId-7228346]Step 11 [bookmark: 96866]Click Save.
 
   [bookmark: pgfId-7228347]The endpoint is added to your deployment and the Create New VPN Deployment pop-up window appears again.
 
   [bookmark: pgfId-7228363]Step 12 Repeat step 6 through step 11 to add more endpoints.
 
   [bookmark: pgfId-7228366]Step 13 Click Save to complete your deployment and the VPN page appears again. 
 
   [bookmark: pgfId-7286280]Note that you must apply the deployment for it to take effect; see Applying a VPN Deployment.
 
   [bookmark: pgfId-7306623]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7212230]Configuring Advanced [bookmark: marker-7316660]VPN Deployment Settings
 
    [bookmark: pgfId-7212223]License: VPN
 
    [bookmark: pgfId-7244946]Supported Devices: Series 3
 
    [bookmark: pgfId-7228739]VPN deployments contain some common settings that can be shared among the VPNs in a deployment. Each VPN can use the default settings or you can override the default settings. Advanced settings typically require little or no modification and are not common to every deployment.
 
    [bookmark: pgfId-7234988]The following list describes the advanced options you can specify in your deployment.
 
    [bookmark: pgfId-7231014]Other Algorithm Allowed
 
    [bookmark: pgfId-7291238]Select the check box to enable auto negotiation to an algorithm not listed in the Algorithm list, but proposed by the remote peer.
 
    [bookmark: pgfId-7291239]Algorithm
 
    [bookmark: pgfId-7231132]Specify the phase one and phase two algorithm proposals to secure data in your deployment. Select Cipher, Hash, and Diffie-Hellman (DH) group authentication messages for both phases.
 
    [bookmark: pgfId-7231138]IKE Life Time
 
    [bookmark: pgfId-7231161]Specify a numerical value and select a time unit for the maximum IKE SA renegotiation interval. You can specify a minimum of 15 minutes and a maximum of 30 days.
 
    [bookmark: pgfId-7231166]IKE v2
 
    [bookmark: pgfId-7231179]Select the check box to specify that the system uses IKE version 2. This version supports the star deployment and multiple protected networks.
 
    [bookmark: pgfId-7231189]Life Time
 
    [bookmark: pgfId-7231208]Specify a numerical value and select a time unit for the maximum SA renegotiation interval. You can specify a minimum of 5 minutes and a maximum of 24 hours.
 
    [bookmark: pgfId-7231224]Life Packets
 
    [bookmark: pgfId-7231249]Specify the number of packets that can be transmitted over an IPsec SA before it expires. You can use any integer between 0 and 18446744073709551615.
 
    [bookmark: pgfId-7231255]Life Bytes
 
    [bookmark: pgfId-7231273]Specify the number of bytes that can be transmitted over an IPsec SA before it expires. You can use any integer between 0 and 18446744073709551615.
 
    [bookmark: pgfId-7231283]AH
 
    [bookmark: pgfId-7231291]Select the check box to specify that the system uses the authentication header security protocol for the data to be protected. Clear the check box to use encryption service payload (ESP) protocol. See Understanding IPSec for guidance on when to use each protocol.
 
    [bookmark: pgfId-7211860]To configure advanced VPN deployment settings:
 
    [bookmark: pgfId-7211910]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7232069]Step 1 Select Devices > VPN.
 
    [bookmark: pgfId-7232070]The VPN page appears.
 
    [bookmark: pgfId-7232071]Step 2 Click Add.
 
    [bookmark: pgfId-7232072]The Create New VPN Deployment pop-up window appears.
 
    [bookmark: pgfId-7232073]Step 3 Click the Advanced tab.
 
    [bookmark: pgfId-7232087]Step 4 Configure the advanced settings, as described earlier in this section.
 ). 
    
 
    [bookmark: pgfId-7232092]The Add IKE Algorithm Proposal pop-up window appears.
 
    [bookmark: pgfId-7232093]Step 6 Select Cipher, Hash, and Diffie-Hellman (DH) group authentication messages for both phases.
 
    [bookmark: pgfId-7232094]Step 7 Click OK.
 
    [bookmark: pgfId-7232095]The IKE algorithm proposal is added.
 
    [bookmark: pgfId-7232097]Step 8 Click Save.
 
    [bookmark: pgfId-7232098]Your changes are saved and the VPN page appears.
 
    [bookmark: pgfId-7285789]Note that you must apply the deployment for it to take effect; see Applying a VPN Deployment.
 
    [bookmark: pgfId-7306660]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7239068][bookmark: 33695]Applying a VPN Deployment
 
    [bookmark: pgfId-7245816]License: VPN
 
    [bookmark: pgfId-7245817]Supported Devices: Series 3
 
    [bookmark: pgfId-7318998]After configuring or making any changes to a VPN deployment, you must apply the deployment to one or more devices to implement the settings you designated for the deployment.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7318999] 
     Caution Adding or removing a VPN on a Series 3 device restarts the Snort process when you apply your changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7239162]To apply a VPN deployment:
 
    [bookmark: pgfId-7239215]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7239270]Step 1 Select Devices > VPN.
 
    [bookmark: pgfId-7239271]The VPN page appears.
 ) next to the VPN deployment that you want to apply. 
    
 
    [bookmark: pgfId-7239921]Step 3 When prompted, click Yes.
 
    [bookmark: pgfId-7239922]The VPN deployment is applied.
 
     
      
    
 
    
 
    [bookmark: pgfId-7239942]Tip Optionally, from the Apply VPN deployment dialog box, click View Changes. The VPN Comparison View page appears in a new browser window. For more information, see Using the VPN Deployment Comparison View.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7239943]Step 4 Click OK.
 
    [bookmark: pgfId-7239266]You are returned to the VPN page.
 
    [bookmark: pgfId-7306666]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7212828][bookmark: 54494]Viewing V[bookmark: marker-7288491]PN Deployment Status
 
    [bookmark: pgfId-7212876]License: VPN
 
    [bookmark: pgfId-7245911]Supported Devices: Series 3
 
    [bookmark: pgfId-7217754]After you configure a VPN deployment, you can view the status of your configured VPN tunnels. The VPN page displays a status icon for each applied VPN deployment:
 
     
     	 [bookmark: pgfId-7249433]The (
 
     [image: ] ) icon designates that all VPN endpoints are up. 
    
 
     
     	 [bookmark: pgfId-7249434]The (
 
     [image: ] ) icon designates that all VPN endpoints are down. 
    
 
     
     	 [bookmark: pgfId-7249435]The (
 
     [image: ] ) icon designates that some endpoints are up, while others are down. 
    
 
    [bookmark: pgfId-7240091]You can click a status icon to view the deployment status along with basic information about the endpoints in the deployment, such as endpoint name and IP address. The VPN status updates every minute or when a status change occurs, such as an endpoint going down or coming up.
 
    [bookmark: pgfId-7232300]To view VPN status:
 
    [bookmark: pgfId-7232301]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7232302]Step 1 Select Devices > VPN.
 
    [bookmark: pgfId-7252813]The VPN page appears.
 
    [bookmark: pgfId-7252814]Step 2 Click the VPN status icon next to the deployment where you want to view the status.
 
    [bookmark: pgfId-7242296]The VPN Status pop-up window appears.
 
    [bookmark: pgfId-7242300]Step 3 Click OK to return to the VPN page.
 
    [bookmark: pgfId-7306676]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7208053]Viewing [bookmark: marker-7316672]VPN Statistics and Logs
 
    [bookmark: pgfId-7208085]License: VPN
 
    [bookmark: pgfId-7245930]Supported Devices: Series 3
 
    [bookmark: pgfId-7249597]After you configure a VPN deployment, you can view statistics about the data traversing your configured VPN tunnels. In addition, you can view the latest VPN system and IKE logs for each endpoint.
 
    [bookmark: pgfId-7263516]The system displays the following statistics.
 
    [bookmark: pgfId-7263520]Endpoint
 
    [bookmark: pgfId-7263680]The device path to the routed interface and IP address designated as the VPN endpoint.
 
    [bookmark: pgfId-7263686]Status
 
    [bookmark: pgfId-7263569]Whether the VPN connection is up or down.
 
    [bookmark: pgfId-7263654]Protocol
 
    [bookmark: pgfId-7263715]The protocol used for encryption, either ESP or AH.
 
    [bookmark: pgfId-7263721]Packets Received
 
    [bookmark: pgfId-7263743]The number of packets per interface the VPN tunnel receives during an IPsec SA negotiation.
 
    [bookmark: pgfId-7263802]Packets Forwarded
 
    [bookmark: pgfId-7263842]The number of packets per interface the VPN tunnel transmits during an IPsec SA negotiation.
 
    [bookmark: pgfId-7263848]Bytes Received
 
    [bookmark: pgfId-7263868]The number of bytes per interface the VPN tunnel receives during an IPsec SA negotiation.
 
    [bookmark: pgfId-7263885]Bytes Forwarded
 
    [bookmark: pgfId-7263911]The number of bytes per interface the VPN tunnel transmits during an IPsec SA negotiation.
 
    [bookmark: pgfId-7263923]Time Created
 
    [bookmark: pgfId-7263939]The date and time the VPN connection was created.
 
    [bookmark: pgfId-7263947]Time Last Used
 
    [bookmark: pgfId-7263963]The last time a user initiated a VPN connection.
 
    [bookmark: pgfId-7263965]NAT Traversal
 
    [bookmark: pgfId-7263980]If Yes is displayed, at least one of the VPN endpoints resides behind a device with network address translation.
 
    [bookmark: pgfId-7263982]IKE State
 
    [bookmark: pgfId-7263989]The state of the IKE SA: connecting, established, deleting, or destroying.
 
    [bookmark: pgfId-7263996]IKE Event
 
    [bookmark: pgfId-7264011]The IKE SA event: reauthentication or rekeying.
 
    [bookmark: pgfId-7264021]IKE Event Time
 
    [bookmark: pgfId-7264037]The time in seconds the next event should occur.
 
    [bookmark: pgfId-7264043]IKE Algorithm
 
    [bookmark: pgfId-7264057]The IKE algorithm being used by the VPN deployment.
 
    [bookmark: pgfId-7264145]IPSec State
 
    [bookmark: pgfId-7264146]The state of the IPSec SA: installing, installed, updating, rekeying, deleting, and destroying.
 
    [bookmark: pgfId-7264147]IPSec Event
 
    [bookmark: pgfId-7264148]Notification of when the IPSec SA event is rekeying.
 
    [bookmark: pgfId-7264149]IPSec Event Time
 
    [bookmark: pgfId-7264150]The time in seconds until the next event should occur.
 
    [bookmark: pgfId-7249598]IPSec Algorithm
 
    [bookmark: pgfId-7264180]IPSec algorithm being used by the VPN deployment.
 
    [bookmark: pgfId-7264166]To view VPN statistics:
 
    [bookmark: pgfId-7242132]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7242157]Step 1 Select Devices > VPN.
 
    [bookmark: pgfId-7242158]The VPN page appears.
 
    [bookmark: pgfId-7242159]Step 2 Click the VPN status icon next to the deployment where you want to view the VPN statistics.
 
    [bookmark: pgfId-7243300]The VPN Status pop-up window appears.
 ). 
    
 
    [bookmark: pgfId-7243305]The VPN Statistics pop-up window appears.
 
    [bookmark: pgfId-7232175]Step 4 Optionally, click Refresh to update the VPN statistics.
 
    [bookmark: pgfId-7248956]Step 5 Optionally, click View Recent Log to view the latest data log for each endpoint.
 
    [bookmark: pgfId-7253413]To view the log for clustered devices and stacked devices, you can select the link for either the active/primary or backup/secondary device.
 
    [bookmark: pgfId-7306736]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7248958][bookmark: 73670]Using the V[bookmark: marker-7288571]PN Deployment Comparison View
 
    [bookmark: pgfId-7248959]License: VPN
 
    [bookmark: pgfId-7245973]Supported Devices: Series 3
 
    [bookmark: pgfId-7248576]The VPN deployment comparison view allows you to view the changes you have made to a deployment before you apply them. The report displays all differences between the current deployment and the proposed deployment. This gives you an opportunity to discover any potential configuration errors.
 
    [bookmark: pgfId-7248702]The comparison view displays both deployments in a side-by-side format, with each deployment identified by name in the title bar on the left and right sides of the comparison view. The time of last modification and the last user to modify are displayed with the deployment name.
 
    [bookmark: pgfId-7248604]Differences between the two deployments are highlighted:
 
     
     	 [bookmark: pgfId-7248605]Blue indicates that the highlighted setting is different in the two deployments, and the difference is noted in red text. 
 
     	 [bookmark: pgfId-7248606]Green indicates that the highlighted setting appears in one deployment but not the other.
 
    
 
    [bookmark: pgfId-7248607]You can perform any of the actions in the following table.
 
    [bookmark: pgfId-7248642]
 
     
      
       
       [bookmark: pgfId-7248614]Table 10-2 VPN Deployment Comparison View Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-7248618]To... 
         
  
        	 
          
          [bookmark: pgfId-7248620]You can... 
         
  
       
 
        
        	[bookmark: pgfId-7248622]navigate individually through changes
  
        	[bookmark: pgfId-7248624]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
       
 
        
        	[bookmark: pgfId-7248638]generate a deployment comparison report
  
        	[bookmark: pgfId-7248640]click Comparison Report. 
 
         
  
       
 
       
     
 
    
 
   
 
  
  
   
   
    
     [bookmark: pgfId-6753877][bookmark: 33368]Using N[bookmark: marker-7276954]AT Policies 
      
      
 
     
 
 
    [bookmark: pgfId-7222880]A network address translation (NAT) policy determines how the system achieves routing with network address translation. You can configure one or more NAT policies, which you can then apply to one or more managed devices. Each device can have one currently applied policy.
 
    [bookmark: pgfId-7223737]You add NAT rules to a policy to control how the system handles network address translations. Each rule contains a set of conditions that identify the specific traffic you want to translate. You can create the following types of rules:
 
     
     	 [bookmark: pgfId-7223939]static, which provide one-to-one translations on destination networks and optionally port and protocol
 
     	 [bookmark: pgfId-7223992]dynamic IP, which translate many-to-many source networks, but maintain port and protocol
 
     	 [bookmark: pgfId-7224026]dynamic IP and port, which translate many-to-one or many-to-many source networks and port and protocol
 
    
 
    [bookmark: pgfId-7224366]The system matches traffic to static translations before dynamic translations are inspected. The system then matches traffic to dynamic NAT rules in order; the first-matched rules handle the traffic. See Organizing Rules in a NAT Policy for more information.
 
    [bookmark: pgfId-7232444]If you have access control policies in your deployment, the system does not translate traffic until it has passed through access control.
 
    [bookmark: pgfId-7222033]To configure and apply NAT policies on your appliances, you must have a Control license enabled on each of your target managed devices. Additionally, you can only apply NAT policies to Series 3 devices with configured virtual routers or hybrid interfaces.
 
    [bookmark: pgfId-7261710]After you have configured and deployed NAT policies, you can use the command line interface (CLI) for managed device targets to troubleshoot the deployment. The CLI displays three types of NAT information: configuration, rule definitions, and active translations. See Command Line Reference for more information.
 
    [bookmark: pgfId-7215258]See the following sections for more information on creating and managing NAT policies:
 
     
     	 [bookmark: pgfId-7213457]Planning and Implementing a NAT Policy
 
     	 [bookmark: pgfId-7213482]Configuring NAT Policies
 
     	 [bookmark: pgfId-7237207]Organizing Rules in a NAT Policy
 
     	 [bookmark: pgfId-7213486]Managing NAT Policies
 
     	 [bookmark: pgfId-7237216]Creating and Editing NAT Rules
 
     	 [bookmark: pgfId-7237238]Understanding NAT Rule Types
 
     	 [bookmark: pgfId-7237338]Understanding NAT Rule Conditions and Condition Mechanics
 
     	 [bookmark: pgfId-7213577]Working with Different Types of Conditions in NAT Rules
 
    
 
   
 
    
     [bookmark: pgfId-7213487][bookmark: 81758]Planning and Implementing a NAT Policy
 
    [bookmark: pgfId-7213365]License: Any
 
    [bookmark: pgfId-7223565]You can configure NAT policies in different ways to manage specific network needs. This section provides information for some of the ways you can deploy NAT policies.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7285129] 
     Caution In clustered configurations, only select an individual peer interface for a static NAT rule on a clustered device if all networks affected by the NAT translations are private. Do 
     not use this configuration for static NAT rules affecting traffic between public and private networks. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7223566]You can configure NAT to expose an internal server to an external network. In this configuration, you define a static translation from an external IP address to an internal IP address so the system can access an internal server from outside the network. Traffic sent to the server targets the external IP address or IP address and port, and is translated into the internal IP address or IP address and port. Return traffic from the server is translated back to the external address.
 
    [bookmark: pgfId-7223567]You can configure NAT to allow an internal host or server to connect to an external application. In this configuration, you define a static translation from an internal address to an external address. This definition allows the internal host or server to initiate a connection to an external application that is expecting the internal host or server to have a specific IP address and port. Therefore, the system cannot dynamically allocate the address of the internal host or server.
 
    [bookmark: pgfId-7223568]You can configure NAT to hide private network addresses from an external network by using a block of IP addresses. This becomes useful if you want to obscure your internal network addresses and have sufficient external IP addresses to satisfy your internal network needs. In this configuration, you create a dynamic translation that automatically converts the source IP address of any outgoing traffic to an unused IP address from your externally facing IP addresses.
 
    [bookmark: pgfId-7213661]You can configure NAT to hide private network addresses from an external network using a limited block of IP addresses and port translation. This becomes useful if you want to obscure your internal network addresses, but have an insufficient number of external IP addresses to satisfy your internal network needs. In this configuration, you create a dynamic translation that automatically converts the source IP address and port of outgoing traffic to an unused IP address and port from your externally facing IP addresses.
 
   
 
    
     [bookmark: pgfId-7208667][bookmark: 82591]Configurin[bookmark: marker-7276959]g NAT Policies
 
    [bookmark: pgfId-7298091]License: Control
 
    [bookmark: pgfId-7298098]Supported Devices: Series 3
 
    [bookmark: pgfId-7298099]To configure a NAT policy, you must give the policy a unique name and identify the devices, or targets, where you want to apply the policy. You can also add, edit, delete, enable, and disable NAT rules. After you create or modify a NAT policy, you can apply the policy to all or some targeted devices.
 
    [bookmark: pgfId-7277486]You can apply NAT policies to a device cluster, including clustered stacks, as you would a standalone device. However, you can define static NAT rules for interfaces on individual clustered devices or the entire cluster and use the interfaces in source zones. For dynamic rules, you can use only the interfaces on the entire cluster in source or destination zones.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7284788] 
     Caution In clustered configurations, only select an individual peer interface for a static NAT rule on a clustered device if all networks affected by the NAT translations are private. Do 
     not use this configuration for static NAT rules affecting traffic between public and private networks. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7277487]If you configure dynamic NAT on a device cluster without HA link interfaces established, both clustered devices independently allocate dynamic NAT entries, and the system cannot synchronize the entries between devices. See Configuring HA Link Interfaces for more information.
 
    [bookmark: pgfId-7263346]You can apply NAT policies to a device stack as you would a standalone device. If you establish a device stack from devices that were included in a NAT policy and had rules associated with interfaces from the secondary device that was a member of the stack, the interfaces from the secondary device remain in the NAT policy. You can save and apply policies with the interfaces, but the rules do not provide any translation. See Managing Stacked Devices for more information.
 
    [bookmark: pgfId-7214108]The following table summarizes the configuration actions you can take on the NAT policy Edit page.
 
    [bookmark: pgfId-7214232]
 
     
     Creating and Editing NAT Rules 
     
 
     
 
      
       
       [bookmark: pgfId-7214115]Table 11-1 NAT Policy Configuration Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-7214119]To... 
         
  
        	 
          
          [bookmark: pgfId-7214121]You can... 
         
  
       
 
        
        	[bookmark: pgfId-7214123]modify the policy name or description
  
        	[bookmark: pgfId-7214125]click the Name or Description field, delete any characters as needed, then type the new name or description.
  
       
 
        
        	[bookmark: pgfId-7214148]manage policy targets
  
        	[bookmark: pgfId-7214153]find more information at Managing NAT Policy Targets.
  
       
 
        
        	[bookmark: pgfId-7214155]save your policy changes
  
        	[bookmark: pgfId-7214157]click Save.
  
       
 
        
        	[bookmark: pgfId-7214159]save and apply your policy
  
        	[bookmark: pgfId-7214163]click Save and Apply. See Applying a NAT Policy for more information.
  
       
 
        
        	[bookmark: pgfId-7214170]cancel your policy changes
  
        	[bookmark: pgfId-7214172]click Cancel, then, if you have made changes, click OK.
  
       
 
        
        	[bookmark: pgfId-7214174]add a rule to a policy
  
        	[bookmark: pgfId-7214178]click Add Rule. See Creating and Editing NAT Rules for more information.
 .  
       
 
        
        	[bookmark: pgfId-7214182]edit an existing rule
  ) next to the rule. See for more information. . 
       
 
        
        	[bookmark: pgfId-7214193]delete a rule
  . . 
       
 
        
        	[bookmark: pgfId-7214201]enable or disable an existing rule
  
        	[bookmark: pgfId-7214203]right-click a selected rule, select State, then select Disable or Enable. Disabled rules are grayed and marked (disabled) beneath the rule name.
  
       
 
        
        	[bookmark: pgfId-7224560]display the configuration page for a specific rule attribute 
  
        	[bookmark: pgfId-7224562]click the name, value, or icon in the column for the condition on the row for the rule. For example, click the name or value in the Source Networks column to display the Source Network page for the selected rule. See Working with Different Types of Conditions in NAT Rules for more information.
  
       
 
       
     
 
    
 
     
      [bookmark: pgfId-7209061][bookmark: 35245]Managing NAT P[bookmark: marker-7276966]olicy Targets
 
     [bookmark: pgfId-7210883]License: Control
 
     [bookmark: pgfId-7218058]Supported Devices: Series 3
 
     [bookmark: pgfId-7236279]Before you can apply a NAT policy, you must identify the managed devices, including device stacks, clusters, or groups, where you want to apply the policy. You can identify the managed devices you want to target with your policy while creating or editing a policy. You can search a list of available devices, stacks, and clusters, and add them to a list of selected devices. You can also drag and drop selected devices, or add devices using the button between the two lists.
 
     [bookmark: pgfId-7236287]Note that you cannot target stacked devices running different versions of the FireSIGHT System (for example, if an upgrade on one of the devices fails). See Managing Stacked Devices for more information.
 
      
      
 
      
 
       
        
        [bookmark: pgfId-7213031]Table 11-2 [bookmark: 34972]Targeted Device Management Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-7213035]To... 
          
  
         	 
           
           [bookmark: pgfId-7213037]You can... 
          
  
        
 
         
         	[bookmark: pgfId-7213039]search a list of available devices, stacks, and clusters
  
         	[bookmark: pgfId-7213041]click inside the search field, then type a search string. The list of devices updates as you type to display matching device names.
  
        
 
         
         	[bookmark: pgfId-7213043]clear a search for available devices
  ) in the search field. 
        
 
         
         	[bookmark: pgfId-7213050]select available devices, stacks, or clusters to add to the list of selected targets
  
         	[bookmark: pgfId-7213052]click the device name; use the Ctrl and Shift keys to select multiple devices.
 .  
        
 
         
         	[bookmark: pgfId-7213055]add selected devices, stacks, or clusters
  
         	[bookmark: pgfId-7213057]click Add to Policy.
 [bookmark: pgfId-7213058]Tip You can also drag and drop into the list of selected devices.  
        
 
         
         	[bookmark: pgfId-7213060]delete a single device, stack, or cluster from the Selected Devices list
  ) next to the device. . 
        
 
         
         	[bookmark: pgfId-7213068]delete multiple devices from the Selected Devices list
  
         	[bookmark: pgfId-7213070]use the Ctrl and Shift keys to select multiple devices, right-click to highlight the row for a selected device, then click Delete Selected. 
  
        
 
         
         	[bookmark: pgfId-7213072]save your configuration
  
         	[bookmark: pgfId-7213074]click Save.
  
        
 
         
         	[bookmark: pgfId-7213076]discard your configuration without saving your changes
  
         	[bookmark: pgfId-7213078]click Cancel.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7213127]The following procedure explains how to configure a NAT policy to manage targeted devices. See Editing a NAT Policy for the complete procedure for editing a NAT policy.
 
     [bookmark: pgfId-7213131]To manage targeted devices in a NAT policy:
 
     [bookmark: pgfId-7213132]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7213133]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7213134]The NAT page appears.
 ) next to the NAT policy you want to configure. 
     
 
     [bookmark: pgfId-7213139]The NAT Policy Editor page appears.
 
     [bookmark: pgfId-7213140]Step 3 Click the Targets tab.
 
     [bookmark: pgfId-7213141]The Targets page appears.
 
     [bookmark: pgfId-7213142]Step 4 Optionally, click the Search prompt above the Available Devices list, then type a name.
 ) to clear the list. 
     
 
     [bookmark: pgfId-7213147]Step 5 Click the device, stack, cluster, or device group you want to add. Use Ctrl and Shift to select multiple devices.
 
      
       
     
 
     
 
     [bookmark: pgfId-7213148]Tip You can also right-click an available device, then click Select All.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7213149]Step 6 Click Add to Policy.
 
     [bookmark: pgfId-7213150]Selected devices are added.
 
      
       
     
 
     
 
     [bookmark: pgfId-7213151]Tip You can also drag and drop to add devices.
 
      
      
 
     
 
     
 . 
     
 
     [bookmark: pgfId-7312992]Step 8 Click Save to save your configuration, or click Cancel to discard it.
 
     [bookmark: pgfId-7313012]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7312995][bookmark: 54100]Organizing R[bookmark: marker-7312994]ules in a NAT Policy
 
    [bookmark: pgfId-7312999]License: Any
 
    [bookmark: pgfId-7274384]The Edit page for the NAT policy lists static NAT rules and dynamic NAT rules separately. The system sorts static rules alphabetically by name, and you cannot change the display order. You cannot create static rules with identical matching values. The system inspects static translations for a match before it inspects any dynamic translations.
 
    [bookmark: pgfId-7274385]Dynamic rules are processed in numerical order. The numeric position of each dynamic rule appears on the left side of the page next to the rule. You can move or insert dynamic rules and otherwise change the rule order. For example, if you move dynamic rule 10 under dynamic rule 3, rule 10 becomes rule 4 and all subsequent numbers increment accordingly.
 
    [bookmark: pgfId-7274432]A dynamic rule’s position is important because the system compares packets to dynamic rules in the rules' numeric order on the policy Edit page. When a packet meets all the conditions of a dynamic rule, the system applies the conditions of that rule to the packet and ignores all subsequent rules for that packet.
 
    [bookmark: pgfId-7225275]Optionally, you can specify a dynamic rule’s numeric position when you add or edit a dynamic rule. You can also highlight a dynamic rule before adding a new dynamic rule to insert the new rule below the rule you highlighted. See Creating and Editing NAT Rules.
 
    [bookmark: pgfId-7225280]You can select one or more dynamic rules by clicking a blank space in the row for the rule. You can drag and drop selected dynamic rules into a new location, thereby changing the position of the rules you moved and all subsequent rules. 
 
    [bookmark: pgfId-7272616]You can cut or copy selected rules and paste them above or below an existing rule. You can only paste static rules in the Static Translations list and only dynamic rules in the Dynamic Translations list. You can also delete selected rules and insert new rules into any location in the list of existing rules.
 
     
      
    
 
    
 
    [bookmark: pgfId-7251229]Note You can copy, but not cut static rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7225282]You can display explanatory warnings to identify rules that will never match because they are preempted by preceding rules.
 
    [bookmark: pgfId-7232640]If you have access control policies in your deployment, the system does not translate traffic until it has passed through access control.
 
     
     
 
     
 
      
       
       [bookmark: pgfId-7225862]Table 11-3 [bookmark: 68656]NAT Rule Organization Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-7225866]To... 
         
  
        	 
          
          [bookmark: pgfId-7225868]You can... 
         
  
       
 
        
        	[bookmark: pgfId-7225891]select a rule
  
        	[bookmark: pgfId-7225893]click a blank area in the row for a rule. Use the Ctrl or Shift key to select multiple rules. Rules you select are highlighted.
  
       
 
        
        	[bookmark: pgfId-7225896]clear rule selections
  ) on the lower right side of the page. To clear individual rules, click a blank area in a rule's row while holding the Ctrl key. 
       
 
        
        	[bookmark: pgfId-7225903]cut or copy selected rules 
  
        	[bookmark: pgfId-7225905]right-click a blank area in the row for a selected rule, then select Cut or Copy.
 [bookmark: pgfId-7251117]Tip You can copy, but not cut static rules.  
       
 
        
        	[bookmark: pgfId-7225907]paste rules you have cut or copied into the rule list
  
        	[bookmark: pgfId-7225909]right-click a blank area in the row for a rule where you want to paste selected rules, then select Paste above or Paste below.
 [bookmark: pgfId-7251552]Tip You can only paste static rules in the Static Translations list and only dynamic rules in the Dynamic Translations list.  
       
 
        
        	[bookmark: pgfId-7225911]move selected rules
  
        	[bookmark: pgfId-7225913]drag and drop selected rules beneath a new location, indicated by a horizontal blue line that appears above your pointer as you drag.
  
       
 
        
        	[bookmark: pgfId-7225915]delete a rule
  . to delete one or more selected rules. 
       
 
        
        	[bookmark: pgfId-7225923]show warnings
  
        	[bookmark: pgfId-7225928]click Show Warnings; see Working with NAT Rule Warnings and Errors.
  
       
 
       
     
 
    
 
     
      [bookmark: pgfId-7225494][bookmark: 91652]Working with NAT Rule [bookmark: marker-7225493]Warnings and Errors
 
     [bookmark: pgfId-7225495]License: Any
 
     [bookmark: pgfId-7270722]The conditions of a NAT rule may preempt a subsequent rule from matching traffic. Any type of rule condition can preempt a subsequent rule.
 
     [bookmark: pgfId-7270771]A rule also preempts an identical subsequent rule where all configured conditions are the same. A subsequent rule would not be preempted if any condition were different.
 
     [bookmark: pgfId-7270772]The following table summarizes the actions you can take to show and clear warnings.
 
     [bookmark: pgfId-7271130]
 
      
      
 
      
 
       
        
        [bookmark: pgfId-7271101]Table 11-4 Preempted Rule Warning Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-7271105]To... 
          
  
         	 
           
           [bookmark: pgfId-7271107]You can... 
          
  
        
 
         
         	[bookmark: pgfId-7271109]show warnings
  ) next to each preempted rule. 
        
 
         
         	[bookmark: pgfId-7271116]display the warning for a rule
  ) next to a rule. A message indicates which rule preempts the rule. 
        
 
         
         	[bookmark: pgfId-7271123]clear warnings
  
         	[bookmark: pgfId-7271125]click Hide Warnings. The page refreshes and the warnings disappear. 
 ), also clears warnings.  
        
 
        
      
 
     
 . 
     
 
    
 
   
 
    
     [bookmark: pgfId-7271624][bookmark: 62661]Managin[bookmark: marker-7277016]g NAT Policies
 
    [bookmark: pgfId-7218465]License: Control
 
    [bookmark: pgfId-7218469]Supported Devices: Series 3
 
    [bookmark: pgfId-7214826]On the NAT policy page (Devices > NAT), you can view all your current NAT policies by name with optional description and the following status information:
 
     
     	 [bookmark: pgfId-7214827]when a policy is up to date on targeted devices, in green text
 
     	 [bookmark: pgfId-7214828]when a policy is out of date on targeted devices, in red text
 
    
 
    [bookmark: pgfId-7212244]Options on this page allow you to compare policies, create a new policy, apply a policy to targeted devices, copy a policy, view a report that lists all of the most recently saved settings in each policy, and edit a policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-7262434]Note After you have applied a NAT policy to a managed device, you cannot delete the policy, even if it is out of date. Instead, you must apply a NAT policy with no rules to remove the applied NAT rules from the managed device.
 
     
     
 
    
 
    
 
     
     Editing a NAT Policy 
     
 
     Applying a NAT Policy 
     
 
     Copying a NAT Policy 
     
 
     Viewing a NAT Policy Report 
     
 
     
 
     [bookmark: pgfId-7262185] 
     
 
      
       
       [bookmark: pgfId-7212074]Table 11-5 NAT Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-7212078]To... 
         
  
        	 
          
          [bookmark: pgfId-7212080]You can... 
         
  
       
 
        
        	[bookmark: pgfId-7212082]create a new NAT policy
  
        	[bookmark: pgfId-7212086]click New Policy. See Creating a NAT Policy for more information.
  
       
 
        
        	[bookmark: pgfId-7212089]modify the settings in an existing NAT policy
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-7212099]apply a NAT policy to all devices targeted for the policy
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-7212109]copy a NAT policy
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-7212119]view a PDF report that lists the current configuration settings in a NAT policy
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-7212129]compare NAT policies
  
        	[bookmark: pgfId-7212133]click Compare Policies. See Comparing Two NAT Policies for more information.
  
       
 
        
        	[bookmark: pgfId-7212136]delete a NAT policy
  if you decide not to delete the policy. When prompted whether to continue, you are also informed if another user has unsaved changes in the policy. Note After you have applied a NAT policy to a managed device, you cannot delete the policy from the device. Instead, you must apply a NAT policy with no rules to remove the applied NAT rules from the managed device. You also cannot delete a policy that is the last applied policy on any of its target devices, even if it is out of date. Before you can delete the policy completely, you must apply a different policy to those targets. 
       
 
       
     
 
    
 
     
      [bookmark: pgfId-7208081][bookmark: 43916]Creating a N[bookmark: marker-7277036]AT Policy
 
     [bookmark: pgfId-7218485]License: Control
 
     [bookmark: pgfId-7218489]Supported Devices: Series 3
 
     [bookmark: pgfId-7272727]When you create a new NAT policy you must, at minimum, give it a unique name. Although you are not required to identify policy targets at policy creation time, you must perform this step before you can apply the policy; see Managing NAT Policy Targets. If you apply a NAT policy with no rules to a device, the system removes all NAT rules from that device.
 
     [bookmark: pgfId-7214908]To create a NAT policy:
 
     [bookmark: pgfId-7215316]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7215317]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7215318]The NAT page appears.
 
     [bookmark: pgfId-7214912]Step 2 Click New Policy.
 
     [bookmark: pgfId-7214913]The New NAT Policy pop-up window appears.
 
     [bookmark: pgfId-7214918]Step 3 Give the policy a unique Name and, optionally, a Description.
 
     [bookmark: pgfId-7214919]You can use all printable characters, including spaces and special characters.
 
     [bookmark: pgfId-7214921]Step 4 Select the Available Devices where you want to apply the policy.
 ). 
     
 
     [bookmark: pgfId-7214926]Step 5 Add the Selected Devices. You can click and drag, or you can click Add to Policy.
 
     [bookmark: pgfId-7214927]Step 6 Click Save.
 
     [bookmark: pgfId-7214928]The NAT policy Edit page appears. For information on configuring your new policy, including adding rules, see Editing a NAT Policy. Note that you must apply the policy for it to take effect; see Applying a NAT Policy.
 
     [bookmark: pgfId-7313030]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7208120][bookmark: 45659]Editing a N[bookmark: marker-7277098]AT Policy
 
     [bookmark: pgfId-7218506]License: Control
 
     [bookmark: pgfId-7218510]Supported Devices: Series 3
 
     [bookmark: pgfId-7215055]On the NAT policy Edit page, you can configure your policy. See Configuring NAT Policies and for more information.
 
     [bookmark: pgfId-7215062]When you change your configuration, a message indicates that you have unsaved changes. To retain your changes, you must save the policy before exiting the NAT policy Edit page. If you attempt to exit the policy Edit page without saving your changes, you are cautioned that you have unsaved changes; you can then discard your changes and exit the policy, or return to the policy Edit page.
 
     [bookmark: pgfId-7215571]To protect the privacy of your session, after 60 minutes of inactivity on the policy Edit page, changes to your policy are discarded and you are returned to the NAT page. After the first 30 minutes of inactivity, a message appears and updates periodically to provide the number of minutes remaining before changes are discarded. Any activity on the page resets the timer.
 
     [bookmark: pgfId-7215064]When you attempt to edit the same policy in two browser windows, you are prompted whether to resume your edit in the new window, discard your changes in the original window and continue editing in the new window, or cancel the second window and return to the policy Edit page.
 
     [bookmark: pgfId-7215582]When multiple users edit the same policy concurrently, a message for each user on the policy Edit page identifies other users who have unsaved changes. Any user who attempts to save changes is cautioned that saving changes will overwrite changes by other users. When multiple users save the same policy, the last saved changes are retained.
 
     [bookmark: pgfId-7286425]If you change the type of an interface to a type that is not valid for use with a NAT policy that targets a device with that interface, the policy labels the interface as deleted. Click Save in the NAT policy to automatically remove the interface from the policy.
 
     [bookmark: pgfId-7215583]To edit a NAT policy:
 
     [bookmark: pgfId-7215584]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7215562]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7215563]The NAT page appears.
 ) next to the NAT policy you want to configure. 
     
 
     [bookmark: pgfId-7215074]The NAT policy Edit page appears.
 
     [bookmark: pgfId-7215079]Step 3 To configure your policy, take any of the actions described in Configuring NAT Policies.
 
     [bookmark: pgfId-7215094]Step 4 Save or discard your configuration. You have the following choices:
 
      
       
       	 [bookmark: pgfId-7215095]To save your changes and continue editing, click  Save. 
 
       	 [bookmark: pgfId-7215096]To save your changes and apply your policy, click  Save and Apply . See Applying a NAT Policy.
 
      
 
     
 
     [bookmark: pgfId-7215100]You must apply your policy to put your changes into effect.
 
      
       
       	 [bookmark: pgfId-7215532]To discard your changes, click  Cancel and, if prompted, click  OK .
 
      
 
     
 
     [bookmark: pgfId-7215533]Your changes are discarded and the NAT page appears.
 
     [bookmark: pgfId-7313050]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7215535][bookmark: 81183]Copying a NA[bookmark: marker-7277144]T Policy
 
     [bookmark: pgfId-7218554]License: Control
 
     [bookmark: pgfId-7218558]Supported Devices: Series 3
 
     [bookmark: pgfId-7215521]You can copy and rename a NAT policy. A policy you copy includes all policy rules and configurations. 
 
     [bookmark: pgfId-7215508]To copy a NAT policy:
 
     [bookmark: pgfId-7215509]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7215495]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7215496]The NAT page appears.
 ) next to the NAT policy you want to configure. 
     
 
     [bookmark: pgfId-7215449]The Copy NAT Policy pop-up window appears.
 
     [bookmark: pgfId-7215180]Step 3 Enter a unique policy Name.
 
     [bookmark: pgfId-7215181]You can use any printable characters, including spaces and special characters.
 
     [bookmark: pgfId-7313075]Step 4 Click OK.
 
     [bookmark: pgfId-7313076]Your copy appears on the NAT page in alphabetical order by name.
 
     [bookmark: pgfId-7313085]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7313079][bookmark: 67673]Viewing a N[bookmark: marker-7313078]AT Policy Report
 
     [bookmark: pgfId-7218590]License: Control
 
     [bookmark: pgfId-7218594]Supported Devices: Series 3
 
     [bookmark: pgfId-7215682]A NAT policy report is a record of the policy and rules configuration at a specific point in time. You can use the report for auditing purposes or to inspect the current configuration.
 
      
       
     
 
     
 
     [bookmark: pgfId-7215683]Tip You can also generate a NAT comparison report that compares a policy with the currently applied policy or with another policy. For more information, see Comparing Two NAT Policies.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-7215741]Table 11-6 [bookmark: 37175]NAT Policy Report Sections 
 
        
        
         
         	 
           
           [bookmark: pgfId-7215745]Section 
          
  
         	 
           
           [bookmark: pgfId-7215747]Description 
          
  
        
 
         
         	[bookmark: pgfId-7215749]Title Page
  
         	[bookmark: pgfId-7215751]Identifies the name of the policy report, the date and time the policy was last modified, and the name of the user who last modified it.
  
        
 
         
         	[bookmark: pgfId-7215753]Table of Contents
  
         	[bookmark: pgfId-7215755]Describes the contents of the report.
  
        
 
         
         	[bookmark: pgfId-7215757]Policy Information
  
         	[bookmark: pgfId-7215759]Provides the name and description of the policy, the name of the user who last modified the policy, and the date and time the policy was last modified. See Editing a NAT Policy.
  
        
 
         
         	[bookmark: pgfId-7215764]Device Targets
  
         	[bookmark: pgfId-7215766]Lists the managed devices targeted by the policy. See Managing NAT Policy Targets.
  
        
 
         
         	[bookmark: pgfId-7215793]Rules
  
         	[bookmark: pgfId-7215795]Provides the rule type and conditions for each rule in the policy. See Creating and Editing NAT Rules.
  
        
 
         
         	[bookmark: pgfId-7215803]Referenced Objects
  
         	[bookmark: pgfId-7215805]Provides the name and configuration of all individual objects and group objects used in the policy, by type of condition (Zones, Networks, and Ports) where the object is configured.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7215814]To view a NAT policy report:
 
     [bookmark: pgfId-7216386]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7216387]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7216388]The NAT page appears.
 ) next to the policy for which you want to generate a report. Remember to save any changes before you generate a NAT policy report; only saved changes appear in the report. 
     
 
     [bookmark: pgfId-7216343]The system generates the report. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
     [bookmark: pgfId-7313101]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7215930][bookmark: 82109]Comp[bookmark: marker-7277157]aring Two NAT Policies
 
     [bookmark: pgfId-7218624]License: Control
 
     [bookmark: pgfId-7218628]Supported Devices: Series 3
 
     [bookmark: pgfId-7233035]To review policy changes, you can examine the differences between two NAT policies. You can compare any two policies or the currently applied policy with another policy. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies.
 
     [bookmark: pgfId-7233036]There are two tools you can use to compare policies:
 
      
      	 [bookmark: pgfId-7233037]The comparison view displays only the differences between two policies in a side-by-side format. The name of each policy appears in the title bar on the left and right sides of the comparison view except when you select  Running Configuration , in which case a blank bar represents the currently active policy.
 
     
 
     [bookmark: pgfId-7233038]You can use this to view and navigate both policies on the web interface, with their differences highlighted.
 
      
      	 [bookmark: pgfId-7233039]The comparison report creates a record of only the differences between two policies in a format similar to the policy report, but in PDF format.
 
     
 
     [bookmark: pgfId-7233040]You can use this to save, copy, print, and share your policy comparisons for further examination.
 
     [bookmark: pgfId-7233041]For more information on understanding and using policy comparison tools, see the following sections:
 
      
      	 [bookmark: pgfId-7233045]Using the NAT Policy Comparison View
 
      	 [bookmark: pgfId-7232950]Using the NAT Policy Comparison Report
 
     
 
    
 
     
      [bookmark: pgfId-7209330][bookmark: 91784]Using the NAT Policy Comparison View
 
     [bookmark: pgfId-7218651]License: Control
 
     [bookmark: pgfId-7218655]Supported Devices: Series 3
 
     [bookmark: pgfId-7233081]The comparison view displays both policies in a side-by-side format, with each policy identified by name in the title bar on the left and right sides of the comparison view. When comparing two policies other than the running configuration, the time of last modification and the last user to modify are displayed with the policy name.
 
     [bookmark: pgfId-7233086]Differences between the two policies are highlighted:
 
      
      	 [bookmark: pgfId-7233087]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-7233088]Green indicates that the highlighted setting appears in one policy but not the other.
 
     
 
     [bookmark: pgfId-7233089]You can perform any of the actions in the following table.
 
     [bookmark: pgfId-7233124]
 
      
       
        
        [bookmark: pgfId-7233096]Table 11-7 NAT Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-7233100]To... 
          
  
         	 
           
           [bookmark: pgfId-7233102]You can... 
          
  
        
 
         
         	[bookmark: pgfId-7233104]navigate individually through changes
  
         	[bookmark: pgfId-7233106]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-7233112]generate a new policy comparison view
  
         	[bookmark: pgfId-7233114]click New Comparison.
 [bookmark: pgfId-7233115]The Select Comparison window appears. See Using the NAT Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-7233120]generate a policy comparison report
  
         	[bookmark: pgfId-7233122]click Comparison Report. 
 [bookmark: pgfId-7233123]The policy comparison report creates a PDF document that lists only the differences between the two policies.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7209383][bookmark: 87469]Using the NAT Policy Comparison Report
 
     [bookmark: pgfId-7218670]License: Control
 
     [bookmark: pgfId-7218674]Supported Devices: Series 3
 
     [bookmark: pgfId-7237944]A NAT policy comparison report is a record of all differences between two NAT policies or a policy and the currently applied policy identified by the policy comparison view, presented in PDF format. You can use this report to further examine the differences between two policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-7233650]You can generate a NAT policy comparison report from the comparison view for any policies to which you have access. Remember to save any changes before you generate a policy report; only saved changes appear in the report.
 
     [bookmark: pgfId-7233651]The format of the policy comparison report is the same as the policy report, with one exception: the policy report contains all configurations in the policy, while the policy comparison report lists only those configurations that differ between the policies. A NAT policy comparison report contains the sections described in the NAT Policy Report Sections table.
 
     [bookmark: pgfId-7233896]To compare two NAT policies:
 
     [bookmark: pgfId-7233897]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7233898]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7233899]The NAT page appears.
 
     [bookmark: pgfId-7233900]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-7233901]The Select Comparison window appears.
 
     [bookmark: pgfId-7233907]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-7233908]To compare two different policies, select  Other Policy .
 
      
 
     
 
     [bookmark: pgfId-7233909]The page refreshes and the Policy A and Policy B drop-down lists appear.
 
      
       
       	 [bookmark: pgfId-7237973]To compare two different revisions, select  Other Revision .
 
      
 
     
 
     [bookmark: pgfId-7238854]The page refreshes and the Policy, Revision A and Revision B drop-down lists appear.
 
      
       
       	 [bookmark: pgfId-7233910]To compare another policy to the currently active policy, select  Running Configuration. 
 
      
 
     
 
     [bookmark: pgfId-7233911]The page refreshes and the Target/Running Configuration A and Policy B drop-down lists appear.
 
     [bookmark: pgfId-7233912]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-7233913]If you are comparing two different policies, select the policies you want to compare from the  Policy A and  Policy B drop-down lists.
 
       	 [bookmark: pgfId-7238906]If you are comparing two different revisions, select the policy, then select the revisions you want to compare from the  Revision A and  Revision B drop-down lists.
 
       	 [bookmark: pgfId-7233914]If you are comparing the running configuration to another policy, select the second policy from the  Policy B drop-down list.
 
      
 
     
 
     [bookmark: pgfId-7233915]Step 5 Click OK to display the policy comparison view.
 
     [bookmark: pgfId-7233916]The comparison view appears.
 
     [bookmark: pgfId-7234013]Step 6 Optionally, click Comparison Report to generate the NAT policy comparison report.
 
     [bookmark: pgfId-7233723]The NAT policy comparison report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
     [bookmark: pgfId-7313116]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7209308][bookmark: 14330]Applyin[bookmark: marker-7277195]g a NAT Policy
 
     [bookmark: pgfId-7218689]License: Control
 
     [bookmark: pgfId-7218693]Supported Devices: Series 3
 
     [bookmark: pgfId-7216321]After making any changes to a NAT policy, you must apply the policy to one or more devices to implement the configuration changes on the networks monitored by the devices. You must target devices where you want to apply the policy before you can apply the policy. See Managing NAT Policy Targets.
 
     [bookmark: pgfId-7234055]Keep the following points in mind when applying NAT policies:
 
      
      	 [bookmark: pgfId-7234056]You can configure and maintain multiple NAT policies on a Defense Center, but only one policy can be applied to a device at a time.
 
      	 [bookmark: pgfId-7234072]You can apply two different NAT policies to different devices, even though they are both targets for multiple policies.
 
      	 [bookmark: pgfId-7234135]You cannot apply a NAT policy to stacked devices running different versions of the FireSIGHT System (for example, if an upgrade on one of the devices fails). See Managing Stacked Devices for more information.
 
      	 [bookmark: pgfId-7286307]You cannot apply a new NAT policy with a policy apply already pending.
 
      	 [bookmark: pgfId-7273583]If you apply a device configuration that affects the interfaces in a NAT policy, the system reapplies the NAT policy on the device, including the interface changes. However, the policy remains unchanged on the DC and the interface displays an error icon (
 
      [image: ] ). 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7239713]Note Applying an empty NAT policy removes all NAT rules from a device.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7260701]See the following sections for more information:
 
      
      	 [bookmark: pgfId-7260705]Applying a Complete NAT Policy explains how to use the quick-apply option to apply the NAT policy.
 
      	 [bookmark: pgfId-7234249]Applying Selected Policy Configurations explains how to select and apply configurations within the NAT policy.
 
     
 
    
 
     
      [bookmark: pgfId-7211703][bookmark: 77955]Applying a Complete NAT Policy
 
     [bookmark: pgfId-7218709]License: Control
 
     [bookmark: pgfId-7218713]Supported Devices: Series 3
 
     [bookmark: pgfId-7239931]You can apply a NAT policy at any time. Applying a NAT policy also applies any associated rule configurations, objects, and policy changes to the devices targeted by the policy. A pop-up window allows you to apply all changes together as a single quick-apply action.
 
     [bookmark: pgfId-7234321]To quick-apply a complete NAT policy:
 
     [bookmark: pgfId-7234322]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7234323]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7234324]The NAT page appears.
 ) next to the policy you want to apply. 
     
 
     [bookmark: pgfId-7234333]The Apply NAT Rules pop-up window appears.
 
     [bookmark: pgfId-7234340]Alternatively, you can click Save and Apply on the policy Edit page; see Editing a NAT Policy.
 
     [bookmark: pgfId-7234466]Step 3 Click Apply All.
 
     [bookmark: pgfId-7234467]Your policy apply task is queued. Click OK to return to the NAT page.
 
      
       
     
 
     
 
     [bookmark: pgfId-7234468]Tip You can monitor the progress of the policy apply task on the Task Status page (System > Monitoring > Task Status).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7313145]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7216071][bookmark: 61261]Applying Selected Policy Configurations
 
     [bookmark: pgfId-7218736]License: Control
 
     [bookmark: pgfId-7218740]Supported Devices: Series 3
 
     [bookmark: pgfId-7234549]You can use the detailed policy apply page to apply changes to your NAT policy and to any designated targeted devices. The detailed page lists each device targeted by the policy and provides a column for the NAT policy by device. You can specify whether to apply changes to a NAT policy for each targeted device that is out of date.
 
     [bookmark: pgfId-7234640]To apply selected NAT policy configurations:
 
     [bookmark: pgfId-7234641]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7234642]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7234643]The NAT page appears.
 ) next to the policy you want to apply. 
     
 
     [bookmark: pgfId-7234652]The Apply NAT Rules pop-up window appears.
 
     [bookmark: pgfId-7234659]Alternatively, you can click Save and Apply on the policy Edit page; see Editing a NAT Policy.
 
     [bookmark: pgfId-7234661]Step 3 Click Details.
 
     [bookmark: pgfId-7234662]The detailed Apply NAT Rules pop-up window appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-7234667]Tip You can also open the pop-up window from the NAT page (Devices > NAT) by clicking on an out-of-date message in the Status column for the policy.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7234668]Step 4 Select or clear the NAT policy check box next to the device name to specify whether to apply the NAT policy to a targeted device.
 
     [bookmark: pgfId-7234693]Step 5 Click Apply Selected Configurations.
 
     [bookmark: pgfId-7234694]Your policy apply task is queued. Click OK to return to the NAT page.
 
      
       
     
 
     
 
     [bookmark: pgfId-7240495]Tip You can monitor the progress of the policy apply task on the Task Status page (System > Monitoring > Task Status).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7313202]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7240511][bookmark: 47542]Creating and Editing N[bookmark: marker-7277263]AT Rules
 
    [bookmark: pgfId-7218801]License: Control
 
    [bookmark: pgfId-7218805]Supported Devices: Series 3
 
    [bookmark: pgfId-7235021][bookmark: marker-7227664]A NAT rule is simply a set of configurations and conditions that:
 
     
     	 [bookmark: pgfId-7235022]qualifies network traffic
 
     	 [bookmark: pgfId-7235023]specifies how the traffic that matches those qualifications is translated
 
    
 
    [bookmark: pgfId-7235025]You create and edit NAT rules from within an existing NAT policy. Each rule belongs to only one policy.
 
    [bookmark: pgfId-7227434]The web interface for adding or editing a rule is similar. You specify the rule name, state, type, and position (if dynamic) at the top of the page. You build conditions using the tabs on the left side of the page; each condition type has its own tab.
 
    [bookmark: pgfId-7227439]The following list summarizes the configurable components of a NAT rule.
 
    [bookmark: pgfId-7227440]Name
 
    [bookmark: pgfId-7227441]Give each rule a unique name. For static NAT rules, use a maximum of 22 characters. For dynamic NAT rules, use a maximum of 30 characters. You can use printable characters, including spaces and special characters, with the exception of the colon (:).
 
    [bookmark: pgfId-7227442]Rule State
 
    [bookmark: pgfId-7240367]By default, rules are enabled. If you disable a rule, the system does not use it to evaluate network traffic for translation. When viewing the list of rules in a NAT policy, disabled rules are grayed out, although you can still modify them.
 
    [bookmark: pgfId-7227444]Type
 
    [bookmark: pgfId-7227754]A rule’s type determines how the system handles traffic that matches the rule’s conditions. When you create and edit NAT rules, the configurable components vary according to rule type.
 
    [bookmark: pgfId-7227759]For detailed information on rule types and how they affect translation and traffic flow, see Understanding NAT Rule Types.
 
    [bookmark: pgfId-7227760]Position (Dynamic Rules Only)
 
    [bookmark: pgfId-7227452]Dynamic rules in a NAT policy are numbered, starting at 1. The system matches traffic to NAT rules in top-down order by ascending rule number.
 
    [bookmark: pgfId-7227456]When you add a rule to a policy, you specify its position by placing it above or below a specific rule, using rule numbers as a reference point. When editing an existing rule, you can Move the rule in a similar fashion. For more information, see Organizing Rules in a NAT Policy.
 
    [bookmark: pgfId-7227460]Conditions
 
    [bookmark: pgfId-7227461]Rule conditions identify the specific traffic you want to translate. Conditions can match traffic by any combination of multiple attributes, including security zone, network, and transport protocol port.
 
    [bookmark: pgfId-7227464]For detailed information on adding conditions, see Understanding NAT Rule Conditions and Condition Mechanics and Working with Different Types of Conditions in NAT Rules.
 
    [bookmark: pgfId-7227500]To create or edit a NAT rule:
 
    [bookmark: pgfId-7227501]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-7227502]Step 1 Select Devices > NAT.
 
    [bookmark: pgfId-7227503]The NAT page appears.
 ) next to the NAT policy where you want to add a rule. 
    
 
    [bookmark: pgfId-7227508]The NAT policy Edit page appears.
 
    [bookmark: pgfId-7227509]Step 3 Add a new rule or edit an existing rule:
 
     
      
      	 [bookmark: pgfId-7227510]To add a new rule, click  Add Rule .
 
      	 [bookmark: pgfId-7227514]To edit an existing rule, click the edit icon (
 
     
 
     [image: ] ) next to the rule you want to edit. 
    
 
    [bookmark: pgfId-7227515]Either the Add Rule or the Editing Rule page appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-7227516]Tip You can use the right-click context menu to perform many rule creation and management actions; see Using the Context Menu. You can also drag and drop rules to change their order.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7227520]Step 4 Configure the rule components, as described earlier in this section. You can configure the following, or accept the defaults:
 
     
      
      	 [bookmark: pgfId-7227521]You must provide a unique rule  Name .
 
      	 [bookmark: pgfId-7227522]Specify whether the rule is  Enabled .
 
      	 [bookmark: pgfId-7227523]Select a rule  Type .
 
      	 [bookmark: pgfId-7227524]Specify the rule position (dynamic rules only).
 
      	 [bookmark: pgfId-7227525]Configure the rule’s conditions.
 
     
 
    
 
    [bookmark: pgfId-7272894]Static rules must include an original destination network.
 
    [bookmark: pgfId-7273009]Dynamic rules must include a translated source network.
 
    [bookmark: pgfId-7227529]Step 5 Click Add or Save.
 
    [bookmark: pgfId-7227530]Your changes are saved. You must apply the NAT policy for your changes to take effect; see Applying a NAT Policy.
 
    [bookmark: pgfId-7313228]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7227865][bookmark: 93931]Understanding NAT Rule T[bookmark: marker-7277297]ypes
 
    [bookmark: pgfId-7227899]License: Any
 
    [bookmark: pgfId-7227851]Every NAT rule has an associated type that:
 
     
     	 [bookmark: pgfId-7240852]qualifies network traffic
 
     	 [bookmark: pgfId-7228149]specifies how the traffic that matches those qualifications is translated
 
    
 
    [bookmark: pgfId-7244504]The following list summarizes the NAT rule types.
 
    [bookmark: pgfId-7227986]Static
 
    [bookmark: pgfId-7228000]Static rules provide one-to-one translations on destination networks and optionally port and protocol. When configuring static translations, you can configure source zones, destination networks, and destination ports. You cannot configure destination zones or source networks.
 
    [bookmark: pgfId-7249202]You must specify an original destination network. For destination networks, you can only select network objects and groups containing a single IP address or enter literal IP addresses that represent a single IP address. You can only specify a single original destination network and a single translated destination network. 
 
    [bookmark: pgfId-7249209]Optionally, you can specify a single original destination port and a single translated destination port. You must specify an original destination network before you can specify an original destination port. In addition, you cannot specify a translated destination port unless you also specify an original destination port, and the translated value must match the protocol of the original value.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7285580] 
     Caution For static NAT rules on a a clustered device, only select an individual peer interface if all networks affected by the NAT translations are private. Do 
     not use this configuration for static NAT rules affecting traffic between public and private networks. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7228021]Dynamic IP Only
 
    [bookmark: pgfId-7249182]Dynamic IP Only rules translate many-to-many source networks, but maintain port and protocol. When configuring dynamic IP only translations, you can configure zones, source networks, original destination networks, and original destination ports. You cannot configure translated destination networks or translated destination ports.
 
    [bookmark: pgfId-7249216]You must specify at least one translated source network. If the number of translated source network values is less than the number of original source networks, the system displays a warning on the rule that it is possible to run out of translated addresses before all original addresses are matched.
 
    [bookmark: pgfId-7249223]If there are multiple rules with conditions that match the same packet, the low priority rules become dead, meaning they can never be triggered. The system also displays warnings for dead rules. You can view tooltips to determine which rule supersedes the dead rule.
 
     
      
    
 
    
 
    [bookmark: pgfId-7249679]Note You can save and apply policies with dead rules, but the rules cannot provide any translation.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7273146]In some instances, you may want to create rules with limited scope preceding rules with a broader scope. For example:
 
     
     [bookmark: pgfId-7273309]Rule 1: Match on address A and port A/Translate to address B 
    
 
     
     [bookmark: pgfId-7273381]Rule 2: Match on address A/Translate to Address C 
    
 
    [bookmark: pgfId-7273432]In this example, rule 1 matches some packets that also match rule 2. Therefore, rule 2 is not completely dead.
 
    [bookmark: pgfId-7249720]Optionally, you can specify only original destination ports. You cannot specify translated destination ports.
 
    [bookmark: pgfId-7249183]Dynamic IP + Port
 
    [bookmark: pgfId-7228287]Dynamic IP and port rules translate many-to-one or many-to-many source networks and port and protocol. When configuring dynamic IP and port translations, you can configure zones, source networks, original destination networks, and original destination ports. You cannot configure translated destination networks or translated destination ports.
 
    [bookmark: pgfId-7250053]You must specify at least one translated source network. If there are multiple rules with conditions that match the same packet, the low priority rules become dead, meaning they can never be triggered. The system also displays warnings for dead rules. You can view tool tips to determine which rule supersedes the dead rule.
 
     
      
    
 
    
 
    [bookmark: pgfId-7250138]Note You can save and apply policies with dead rules, but the rules cannot provide any translation.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7250204]Optionally, you can specify only original destination ports. You cannot specify translated destination ports.
 
     
      
    
 
    
 
    [bookmark: pgfId-7267152]Note If you create a dynamic IP and port rule, and the system passes traffic that does not use a port, no translation occurs for the traffic. For example, a ping (ICMP) from an IP address that matches the source network does not map, because ICMP does not use a port.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7244875]The following table summarizes the NAT rule condition types that can be configured based on the specified NAT rule type:
 
    [bookmark: pgfId-7244955] 
 
     
      
       
       [bookmark: pgfId-7245024]Table 11-8 Available NAT Rule Condition Types per NAT Rule Type 
 
       
       
        
        	 
          
          [bookmark: pgfId-7245030]Condition 
         
  
        	 
          
          [bookmark: pgfId-7245032]Static 
         
  
        	 
          
          [bookmark: pgfId-7245034]Dynamic (IP Only or IP + Port) 
         
  
       
 
        
        	[bookmark: pgfId-7245039]Source Zones
  
        	[bookmark: pgfId-7245041]Optional
  
        	[bookmark: pgfId-7245046]Optional
  
       
 
        
        	[bookmark: pgfId-7245048]Destination Zones
  
        	[bookmark: pgfId-7245050]Not allowed
  
        	[bookmark: pgfId-7245055]Optional
  
       
 
        
        	[bookmark: pgfId-7245057]Original Source Networks
  
        	[bookmark: pgfId-7245059]Not allowed
  
        	[bookmark: pgfId-7245064]Optional
  
       
 
        
        	[bookmark: pgfId-7245066]Translated Source Networks
  
        	[bookmark: pgfId-7245068]Not allowed
  
        	[bookmark: pgfId-7245073]Required
  
       
 
        
        	[bookmark: pgfId-7245924]Original Destination Networks
  
        	[bookmark: pgfId-7245926]Required
  
        	[bookmark: pgfId-7245928]Optional
  
       
 
        
        	[bookmark: pgfId-7245918]Translated Destination Networks
  
        	[bookmark: pgfId-7245920]Optional; single address only
  
        	[bookmark: pgfId-7245922]Not allowed
  
       
 
        
        	[bookmark: pgfId-7245912]Original Destination Ports
  
        	[bookmark: pgfId-7245914]Optional; single port only, and only allowed if you define the original destination network
  
        	[bookmark: pgfId-7245916]Optional
  
       
 
        
        	[bookmark: pgfId-7245906]Translated Destination Ports
  
        	[bookmark: pgfId-7245908]Optional; single port only, and only allowed if you define the original destination port
  
        	[bookmark: pgfId-7245910]Not allowed
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-7228390][bookmark: 36088]Understanding NAT Rule Con[bookmark: marker-7228389]ditions and Condition Mechanics
 
    [bookmark: pgfId-7228391]License: Any
 
    [bookmark: pgfId-7228392]You can add conditions to NAT rules to identify the type of traffic that matches the rule. For each condition type, you select conditions you want to add to a rule from a list of available conditions. When applicable, condition filters allow you to constrain available conditions. Lists of available and selected conditions may be as short as a single condition or many pages long. You can search available conditions and display only those matching a typed name or value in a list that updates as you type.
 
    [bookmark: pgfId-7228394]Depending on the type of condition, lists of available conditions may be comprised of a combination of conditions provided directly by Cisco or configured using other FireSIGHT System features, including objects created using the object manager (Objects > Object Management), objects created directly from individual conditions pages, and literal conditions.
 
    [bookmark: pgfId-7228401]See the following sections for information on specifying rule conditions:
 
     
     	 [bookmark: pgfId-7228405]Understanding NAT Rule Conditions defines the different types of rule conditions.
 
     	 [bookmark: pgfId-7228409]Adding Conditions to NAT Rules describes the controls used to select and add rule conditions.
 
     	 [bookmark: pgfId-7228413]Searching NAT Rule Condition Lists explains how to search available conditions and display only those matching a typed name or value in a list that updates as you type.
 
     	 [bookmark: pgfId-7228417]Adding Literal Conditions to NAT Rules explains how to add literal conditions to a rule.
 
     	 [bookmark: pgfId-7228421]Using Objects in NAT Rule Conditions explains how to add individual objects to the system from the configuration pages for relevant condition types.
 
    
 
     
      [bookmark: pgfId-7228447][bookmark: 79215]Understanding NAT Rule Con[bookmark: marker-7228446]ditions
 
     [bookmark: pgfId-7228448]License: Any
 
     [bookmark: pgfId-7228449]You can set a NAT rule to match traffic meeting any of the conditions described in the following table:
 
     [bookmark: pgfId-7228571] 
 
      
       
        
        [bookmark: pgfId-7228455]Table 11-9 NAT Rule Condition Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-7228463]Condition 
          
  
         	 
           
           [bookmark: pgfId-7228465]Description 
          
  
         	 
           
           [bookmark: pgfId-7228467]Supported Defense Centers 
          
  
         	 
           
           [bookmark: pgfId-7228472]Supported Devices 
          
  
        
 
         
         	[bookmark: pgfId-7228474]Zones
  
         	[bookmark: pgfId-7228476]A configuration of one or more routed interfaces where you can apply NAT policies. Zones provide a mechanism for classifying traffic on source and destination interfaces, and you can add source and destination zone conditions to rules. See Working with Security Zones for information on creating zones using the object manager.
  
         	[bookmark: pgfId-7228481]Any
  
         	[bookmark: pgfId-7228483]Series 3
  
        
 
         
         	[bookmark: pgfId-7228485]Networks
  
         	[bookmark: pgfId-7228487]Any combination of individual IP addresses, CIDR blocks, and prefix lengths, either specified explicitly or using network objects and groups (see Working with Network Objects). You can add source and destination network conditions to NAT rules.
  
         	[bookmark: pgfId-7228492]Any
  
         	[bookmark: pgfId-7228494]Series 3
  
        
 
         
         	[bookmark: pgfId-7228541]Destination Ports
  
         	[bookmark: pgfId-7228543]Transport protocol ports, including individual and group port objects you create based on transport protocols. See Working with Port Objects for information on creating individual and group transport protocol objects using the object manager.
  
         	[bookmark: pgfId-7228548]Any
  
         	[bookmark: pgfId-7228550]Series 3
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7243406][bookmark: 29478]Adding Co[bookmark: marker-7243405]nditions to NAT Rules
 
     [bookmark: pgfId-7243407]License: Any
 
     [bookmark: pgfId-7275702]Adding conditions to NAT rules is essentially the same for each type of condition. You select from a list of available conditions on the left, and add the selected conditions to one or two lists of selected conditions on the right.
 
     [bookmark: pgfId-7243410]For all condition types, you select one or more individual available conditions by clicking on them to highlight them. You can either click a button between the two types of lists to add available conditions that you select to your lists of selected conditions, or drag and drop available conditions that you select into the list of selected conditions.
 
     [bookmark: pgfId-7252502]You can add up to 50 conditions of each type to a list of selected conditions. For example, you can add up to 50 source zone conditions, up to 50 destination zone conditions, up to 50 source network conditions, and so on, until you reach the upper limit for the appliance.
 
     [bookmark: pgfId-7243429]The following table describes the actions you can take to select and add conditions to a rule.
 
     [bookmark: pgfId-7265534]
 
      
      
 
      Managing Reusable Objects 
      
 
      
 
       
        
        [bookmark: pgfId-7265442]Table 11-10 [bookmark: 84491]Adding Conditions to NAT Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-7265446]To... 
          
  
         	 
           
           [bookmark: pgfId-7265448]You can... 
          
  
        
 
         
         	[bookmark: pgfId-7265450]select available conditions to add to a list of selected conditions
  
         	[bookmark: pgfId-7265452]click the available condition; use the Ctrl and Shift keys to select multiple conditions.
  
        
 
         
         	[bookmark: pgfId-7265454]select all listed available conditions
  
         	[bookmark: pgfId-7265456]right-click the row for any available condition, then click Select All.
  
        
 
         
         	[bookmark: pgfId-7265458]search a list of available conditions or filters
  
         	[bookmark: pgfId-7265460]click inside the Search field and type a search string. See Searching NAT Rule Condition Lists for more information.
  
        
 
         
         	[bookmark: pgfId-7265465]clear a search when searching available conditions or filters
  ) in the Search field. 
        
 
         
         	[bookmark: pgfId-7265475]add selected zone conditions from a list of available conditions to a list of selected source or destination conditions
  
         	[bookmark: pgfId-7265477]click Add to Source or Add to Destination. See Adding Zone Conditions to NAT Rules for more information.
  
        
 
         
         	[bookmark: pgfId-7265482]add selected network and port conditions from a list of available conditions to a list of selected original or translated conditions
  
         	[bookmark: pgfId-7265484]click Add to Original or Add to Translated. See Adding Source Network Conditions to Dynamic NAT Rules, Adding Destination Network Conditions to NAT Rules, or Adding Port Conditions to NAT Rules for more information.
  
        
 
         
         	[bookmark: pgfId-7265495]drag and drop selected available conditions into a list of selected conditions
  
         	[bookmark: pgfId-7265497]click a selected condition, then drag and drop into the list of selected conditions.
  
        
 
         
         	[bookmark: pgfId-7265499]add a literal condition to a list of selected conditions using a literal field
  
         	[bookmark: pgfId-7265501]click to remove the prompt from the literal field, type the literal condition, then click Add. Network conditions provide a field for adding literal conditions.
  
        
 
         
         	[bookmark: pgfId-7265503]add a literal condition to a list of selected conditions using a drop-down list
  
         	[bookmark: pgfId-7265505]select a condition from the drop-down list, then click Add. Port conditions provide a drop-down list for adding literal conditions. See Adding Port Conditions to NAT Rules for more information.
  
        
 
         
         	[bookmark: pgfId-7265510]add an individual object or condition filter so you can then select it from the list of available conditions
  ). See for information on adding objects using the object manager. 
        
 
         
         	[bookmark: pgfId-7265520]delete a single condition from a list of selected conditions
  ) next to the condition 
        
 
         
         	[bookmark: pgfId-7265527]delete a condition from a list of selected conditions
  
         	[bookmark: pgfId-7265529]right-click to highlight the row for a selected condition, then click Delete. 
  
        
 
         
         	[bookmark: pgfId-7265531]delete multiple conditions from a list of selected conditions
  
         	[bookmark: pgfId-7265533]use the Shift and Ctrl keys to select multiple conditions, or right-click and Select All; next, right-click to highlight the row for a selected condition, then click Delete Selected. 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7265540]On the relevant condition page, and also on the policy Edit page, you can hover your pointer over an individual object to display the contents of the object, and over a group object to display the number of individual objects in the group.
 
     [bookmark: pgfId-7243534]The following basic procedure explains how to add conditions to a new rule. See Creating and Editing NAT Rules for complete instructions on adding and modifying rules.
 
     [bookmark: pgfId-7243536]To add available conditions to a list of selected conditions:
 
     [bookmark: pgfId-7243537]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7243538]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7243539]The NAT page appears.
 ) next to the NAT policy you want to modify. 
     
 
     [bookmark: pgfId-7243544]The policy Edit page appears.
 
     [bookmark: pgfId-7275797]Step 3 Click Add Rule.
 
     [bookmark: pgfId-7275811]The Add Rule page appears.
 
     [bookmark: pgfId-7265371]Step 4 Click the tab for the type of condition you want to add to the rule.
 
     [bookmark: pgfId-7243552]The conditions page appears for the type of condition you selected.
 
     [bookmark: pgfId-7243556]Step 5 Take any of the available actions in the Adding Conditions to NAT Rules table.
 
     [bookmark: pgfId-7243557]Step 6 Click Add to save your configuration.
 
     [bookmark: pgfId-7243558]Your rule is added and the policy Edit page appears.
 
     [bookmark: pgfId-7313240]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7243561][bookmark: 85225]Searching NAT Rule Condi[bookmark: marker-7243560]tion Lists
 
     [bookmark: pgfId-7243562]License: Any
 
     [bookmark: pgfId-7243563]You can filter a list of available NAT rule conditions to limit the number of items displayed in the list. The list updates as you type to display matching items.
 
     [bookmark: pgfId-7243564]Optionally, you can search on object names and on the values configured for objects. For example, if you have an individual network object named Texas Office with the configured value 192.168.3.0/24, and the object is included in the group object US Offices, you can display both objects by typing a partial or complete search string such as Tex, or by typing a value such as 3. 
 
     [bookmark: pgfId-7243567]The following basic procedure explains how to filter a list in a new rule. See Creating and Editing NAT Rules for complete instructions on adding and modifying rules.
 
     [bookmark: pgfId-7243569]To search a list of available conditions:
 
     [bookmark: pgfId-7243570]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7243571]Step 1 Select Devices > NAT.
 
     [bookmark: pgfId-7243572]The NAT page appears.
 ) next to the NAT policy you want to modify. 
     
 
     [bookmark: pgfId-7243577]The policy Edit page appears.
 
     [bookmark: pgfId-7243578]Step 3 Click Add Rule.
 
     [bookmark: pgfId-7243579]The Add Rule page appears.
 
     [bookmark: pgfId-7243584]Step 4 To search a list, click inside the search field to clear the prompt, then type a search string.
 ) appears in the search field. The list updates and no items are listed when none match the search string. 
     
 field to clear the search string. 
     
 
     [bookmark: pgfId-7243596]The complete list appears.
 
     [bookmark: pgfId-7243597]Step 6 Click Add to save your configuration.
 
     [bookmark: pgfId-7250969]Your rule is added and the policy Edit page appears.
 
     [bookmark: pgfId-7313260]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7250972][bookmark: 29157]Adding Literal Cond[bookmark: marker-7250971]itions to NAT Rules
 
     [bookmark: pgfId-7250984]License: Any
 
     [bookmark: pgfId-7250985]You can add a literal value to the list of original and translated conditions for the following condition types:
 
      
      	 [bookmark: pgfId-7250986]Networks
 
      	 [bookmark: pgfId-7243605]Ports
 
     
 
     [bookmark: pgfId-7243606]For network conditions, you type the literal value in a configuration field below the list of original or translated conditions.
 
     [bookmark: pgfId-7243607]In the case of port conditions, you select a protocol from a drop-down list. When the protocol is All and, optionally, when the protocol is TCP or UDP, you type a port number in a configuration field.
 
     [bookmark: pgfId-7243608]Each relevant conditions page provides the controls needed to add literal values. Values you type in a configuration field appear as red text if the value is invalid, or until it is recognized as valid. Typed values change to blue text as you type when they are recognized as valid. A grayed Add button activates when a valid value is recognized. Literal values you add appear immediately in the list of selected conditions.
 
     [bookmark: pgfId-7243609]See the following sections for specific details on adding each type of literal value:
 
      
      	 [bookmark: pgfId-7243613]Adding Source Network Conditions to Dynamic NAT Rules
 
      	 [bookmark: pgfId-7260909]Adding Destination Network Conditions to NAT Rules
 
      	 [bookmark: pgfId-7243617]Adding Port Conditions to NAT Rules
 
     
 
    
 
     
      [bookmark: pgfId-7243620][bookmark: 96143]Using Objec[bookmark: marker-7243619]ts in NAT Rule Conditions
 
     [bookmark: pgfId-7243621]License: Any
 
     [bookmark: pgfId-7243622]Objects that you create in the object manager (Objects > Object Management) are immediately available for you to select from relevant lists of available NAT rule conditions. See Managing Reusable Objects for information.
 
     [bookmark: pgfId-7243626]You can also create objects on-the-fly from the NAT policy. A control on relevant conditions pages provides access to the same configuration controls that you use in the object manager.
 
     [bookmark: pgfId-7243627]Individual objects created on-the-fly appear immediately in the list of available objects. You can add them to the current rule, and to other existing and future rules. On the relevant conditions page, and also on the policy Edit page, you can hover your pointer over an individual object to display the contents of the object, and over a group object to display the number of individual objects in the group.
 
    
 
   
 
    
     [bookmark: pgfId-7243630][bookmark: 95899]Working with Different Types of [bookmark: marker-7243629]Conditions in NAT Rules
 
    [bookmark: pgfId-7253109]License: Any
 
    [bookmark: pgfId-7253110]You can match traffic with one or more rule conditions. See the following sections for more information:
 
     
     	 [bookmark: pgfId-7243636]Adding Zone Conditions to NAT Rules explains how to match traffic by security zones that you create using the object manager.
 
     	 [bookmark: pgfId-7243640]Adding Source Network Conditions to Dynamic NAT Rules and Adding Destination Network Conditions to NAT Rules explain how to match traffic by IP address or address block.
 
     	 [bookmark: pgfId-7243644]Adding Port Conditions to NAT Rules explains how to match traffic by specified transport protocol ports.
 
    
 
     
      [bookmark: pgfId-7243647][bookmark: 81282]Adding Zone Co[bookmark: marker-7243646]nditions to NAT Rules
 
     [bookmark: pgfId-7243648]License: Any
 
     [bookmark: pgfId-7243649]The security zones on your system are comprised of interfaces on your managed devices. Zones that you add to a NAT rule target the rule to devices on your network that have routed or hybrid interfaces in those zones. You can only add security zones with routed or hybrid interfaces as conditions for NAT rules. See Working with Security Zones for information on creating security zones using the object manager.
 ) next to a zone to collapse or expand the zone to hide or view its interfaces. 
     
 ) to collapse or expand the clustered device interfaces to hide or view its interfaces. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7262520]Note You can save and apply policies with disabled interfaces, but the rules cannot provide any translation until the interfaces are enabled.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7254167]The two lists on the right are the source and destination zones used for matching purposes by the NAT rules. If the rule already has values configured, these lists display the existing values when you edit the rule. If the source zones list is empty, the rule matches traffic from any zone or interface. If the destination zones list is empty, the rule matches traffic to any zone or interface.
 
     [bookmark: pgfId-7254613]The system displays warnings for rules with zone combinations that never trigger on a targeted device.
 
      
       
     
 
     
 
     [bookmark: pgfId-7254741]Note You can save and apply policies with these zone combinations, but the rules will not provide any translation.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7256152]You can add individual interfaces by selecting an item in a zone or by selecting a standalone interface. You can only add interfaces in a zone if the zone it is assigned to has not already been added to a source zones or destination zones list. These individually selected interfaces are not affected by changes to zones, even if you remove them and add them to a different zone. If an interface is the primary member of a cluster and you are configuring a dynamic rule, you can add only the primary interface to the source zones or destination zones list. For static rules, you can add individual cluster member interfaces to the source zones list. You can only add a primary cluster interface to a list if none of its children have been added, and you can only add individual cluster interfaces if the primary has not been added.
 
     [bookmark: pgfId-7256713]If you add a zone, the rule uses all interfaces associated with the zone. If you add or remove an interface from the zone, the rule will not use the updated version of the zone until the device configuration has been reapplied to the devices where the interfaces reside.
 
      
       
     
 
     
 
     [bookmark: pgfId-7256714]Note In a static NAT rule, you can add only source zones. In a dynamic NAT rule, you can add both source and destination zones.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7256715]The following procedure explains how to add source and destination zone conditions while adding or editing a NAT rule. See Understanding NAT Rule Conditions and Condition Mechanics for more detailed information.
 
     [bookmark: pgfId-7243671]To add zone conditions to a NAT rule:
 
     [bookmark: pgfId-7243672]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7243673]Step 1 Select the Zones tab on the rule Edit page.
 
     [bookmark: pgfId-7275869]The Zones page appears.
 
     [bookmark: pgfId-7243679]Step 2 Optionally, click the Search by name prompt above the Available Zones list, then type a name or value.
 
     [bookmark: pgfId-7243682]The list updates as you type to display matching conditions. See Searching NAT Rule Condition Lists for more information.
 
     [bookmark: pgfId-7254874]Step 3 Click a zone or interface in the Available Zones list. Use the Shift and Ctrl keys to select multiple conditions, or right-click and then click Select All.
 
     [bookmark: pgfId-7254875]Conditions you select are highlighted.
 
     [bookmark: pgfId-7243693]Step 4 You have the following choices:
 
      
       
       	 [bookmark: pgfId-7243694]To match traffic by source zone, click  Add to Source .
 
       	 [bookmark: pgfId-7243695]To match traffic by destination zone, click  Add to Destination .
 
      
 
     
 
     [bookmark: pgfId-7243696]Optionally, you can drag and drop selected conditions into the Source Zones or Destination Zones lists.
 
     [bookmark: pgfId-7243697]Selected conditions are added. Note that while you can add disabled interfaces to a NAT rule, the rule does not provide any translation.
 
      
       
     
 
     
 
     [bookmark: pgfId-7256812]Note You can add only source zones to static NAT rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7243698]Step 5 Save or continue editing the rule.
 
     [bookmark: pgfId-7243701]You must apply the NAT policy for your changes to take effect; see Applying a NAT Policy.
 
     [bookmark: pgfId-7313276]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7243705][bookmark: 92881]Adding Source Network Cond[bookmark: marker-7243704]itions to Dynamic NAT Rules
 
     [bookmark: pgfId-7243706]License: Any
 
     [bookmark: pgfId-7243707]You configure the matching values and translation values of the source IP address for packets. If the original source network is not configured, then any source IP address matches the dynamic NAT rule. Note that you cannot configure source networks for static NAT rules. If a packet matches the NAT rule, the system uses the values in the translated source network to assign the new value for the source IP address. For dynamic rules, you must configure a translated source network with at least one value.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7257339] 
      Caution If a network object or object group is being used by a NAT rule, and you change or delete the object or group, it can cause the rule to become invalid. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7256970]You can add any of the following kinds of source network conditions to a dynamic NAT rule:
 
      
      	 [bookmark: pgfId-7256914]individual and group network objects that you have created using the object manager
 
     
 
     [bookmark: pgfId-7256918]See Working with Network Objects for information on creating individual and group network objects using the object manager.
 
      
      	 [bookmark: pgfId-7256949]individual network objects that you add from the Source Network conditions page, and can then add to your rule and to other existing and future rules
 
     
 
     [bookmark: pgfId-7256953]See Using Objects in NAT Rule Conditions for more information.
 
      
      	 [bookmark: pgfId-7243718]literal, single IP addresses, ranges, or address blocks
 
     
 
     [bookmark: pgfId-7243722]See Adding Literal Conditions to NAT Rules for more information.
 
     [bookmark: pgfId-7243727]The following procedure explains how to add source network conditions while adding or editing a dynamic NAT rule. See Understanding NAT Rule Conditions and Condition Mechanics for more detailed information.
 
     [bookmark: pgfId-7243731]To add network conditions to a dynamic NAT rule:
 
     [bookmark: pgfId-7243732]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7243733]Step 1 Select the Source Networks tab on the rule Edit page.
 
     [bookmark: pgfId-7275903]The Source Network page appears.
 
     [bookmark: pgfId-7243739]Step 2 Optionally, click the Search by name or value prompt above the Available Networks list, then type a name or value.
 
     [bookmark: pgfId-7243742]The list updates as you type to display matching conditions. See Searching NAT Rule Condition Lists for more information.
 
     [bookmark: pgfId-7243744]Step 3 Click a condition in the Available Networks list. Use the Shift and Ctrl keys to select multiple conditions, or right-click and then click Select All. 
 
     [bookmark: pgfId-7243745]Conditions you select are highlighted.
 
     [bookmark: pgfId-7243746]Step 4 You have the following choices:
 
      
       
       	 [bookmark: pgfId-7243747]To match traffic by original source network, click  Add to Original .
 
       	 [bookmark: pgfId-7243748]To specify the translation value for traffic that matches the translated source network, click  Add to Translated .
 
      
 
     
 
     [bookmark: pgfId-7243749]Alternatively, you can drag and drop selected conditions into the Original Source Network or Translated Source Network lists.
 
     [bookmark: pgfId-7243750]Conditions you selected are added.
 list to add an individual network object. 
     
 
     [bookmark: pgfId-7243755]You can add multiple IP addresses, CIDR blocks, and prefix lengths to each network object.
 
     [bookmark: pgfId-7267498]Optionally, you can then select the object you added. See Working with Network Objects and Using Objects in NAT Rule Conditions for more information.
 
     [bookmark: pgfId-7243762]Step 6 Optionally, click the Enter an IP address prompt below the Original Source Network or Translated Source Network list; then type an IP address, range, or address block and click Add.
 
     [bookmark: pgfId-7278232]You add ranges in the following format: lower IP address-upper IP address. For example: 179.13.1.1-179.13.1.10.
 
     [bookmark: pgfId-7243766]The list updates to display your entry. See Adding Literal Conditions to NAT Rules for more information.
 
     [bookmark: pgfId-7243767]Step 7 Save or continue editing the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-7334825]Note When you update the network conditions in a dynamic rule in use in an applied policy, the system drops any network sessions using the existing translated address pool.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7243770]You must apply the NAT policy for your changes to take effect; see Applying a NAT Policy.
 
     [bookmark: pgfId-7313292]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7256393][bookmark: 13899]Adding Destination Network Cond[bookmark: marker-7256392]itions to NAT Rules
 
     [bookmark: pgfId-7256394]License: Any
 
     [bookmark: pgfId-7258256]You configure the matching values and translation values of the destination IP address for packets. Note that you cannot configure translated destination networks for dynamic NAT rules.
 
     [bookmark: pgfId-7258362]Because static NAT rules are one-to-one translations, the Available Networks list contains only network objects and groups that contain only a single IP address. For static translations, you can add only a single object or literal value to both the Original Destination Network or Translated Destination Network lists.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7256395] 
      Caution If a network object or object group is being used by a NAT rule, and you change or delete the object or group, it can cause the rule to become invalid. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7258252]You can add any of the following kinds of destination network conditions to a NAT rule:
 
      
      	 [bookmark: pgfId-7256396]individual and group network objects that you have created using the object manager
 
     
 
     [bookmark: pgfId-7256400]See Working with Network Objects for information on creating individual and group network objects using the object manager.
 
      
      	 [bookmark: pgfId-7256401]individual network objects that you add from the Destination Network conditions page, and can then add to your rule and to other existing and future rules
 
     
 
     [bookmark: pgfId-7256405]See Using Objects in NAT Rule Conditions for more information.
 
      
      	 [bookmark: pgfId-7256406]literal, single IP addresses, range, or address blocks
 
     
 
     [bookmark: pgfId-7258851]For static NAT rules, you can add only a CIDR with subnet mask /32, and only if there is not already a value in the list.
 
     [bookmark: pgfId-7256410]See Adding Literal Conditions to NAT Rules for more information.
 
     [bookmark: pgfId-7256415]The following procedure explains how to add destination network conditions while adding or editing a NAT rule. See Understanding NAT Rule Conditions and Condition Mechanics for more detailed information.
 
     [bookmark: pgfId-7256419]To add destination network conditions to a NAT rule:
 
     [bookmark: pgfId-7256420]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7256421]Step 1 Select the Destination Network tab on the rule Edit page.
 
     [bookmark: pgfId-7275942]The Destination Network page appears.
 
     [bookmark: pgfId-7256427]Step 2 Optionally, click the Search by name or value prompt above the Available Networks list, then type a name or value.
 
     [bookmark: pgfId-7256430]The list updates as you type to display matching conditions. See Searching NAT Rule Condition Lists for more information.
 
     [bookmark: pgfId-7256432]Step 3 Click a condition in the Available Networks list. Use the Shift and Ctrl keys to select multiple conditions, or right-click and then click Select All. 
 
     [bookmark: pgfId-7256433]Conditions you select are highlighted.
 
     [bookmark: pgfId-7256434]Step 4 You have the following choices:
 
      
       
       	 [bookmark: pgfId-7256435]To match traffic by original destination network, click  Add to Original .
 
       	 [bookmark: pgfId-7256436]To specify the translation value for traffic that matches the translated destination network, click  Add to Translated .
 
      
 
     
 
     [bookmark: pgfId-7256437]Alternatively, you can drag and drop selected conditions into the Original Destination Network or Translated Destination Network lists.
 
     [bookmark: pgfId-7256438]Conditions you selected are added.
 list to add an individual network object. 
     
 
     [bookmark: pgfId-7259219]For dynamic rules, you can add multiple IP addresses, CIDR blocks, and prefix lengths to each network object. For static rules, you can add only a single IP address. Optionally, you can then select the object you added. See Working with Network Objects and Using Objects in NAT Rule Conditions for more information.
 
     [bookmark: pgfId-7256450]Step 6 Optionally, click the Enter an IP address prompt below the Original Destination Network or Translated Destination Network list, then type an IP address or address block and click Add.
 
     [bookmark: pgfId-7256453]The list updates to display your entry. See Adding Literal Conditions to NAT Rules for more information.
 
     [bookmark: pgfId-7256455]Step 7 Save or continue editing the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-7334891]Note When you update the network conditions in a dynamic rule in use in an applied policy, the system drops any network sessions using the existing translated address pool.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7256458]You must apply the NAT policy for your changes to take effect; see Applying a NAT Policy.
 
     [bookmark: pgfId-7313311]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7243775][bookmark: 28389]Adding Port Conditi[bookmark: marker-7243774]ons to NAT Rules
 
     [bookmark: pgfId-7243776]License: Any
 
     [bookmark: pgfId-7259973]You can add a port condition to a rule to match network traffic based on the original and translated destination port and transport protocol for translation. If the original port is not configured, any destination port matches the rule. If a packet matches the NAT rule and a translated destination port is configured, the system translates the port into that value. Note that for dynamic rules, you can specify only the original destination port. For static rules, you can define a translated destination port, but only with an object with the same protocol as the original destination port object or literal value.
 
     [bookmark: pgfId-7267887]The system matches the destination port against the value of the port object or literal port in the original destination port list for static rules, or multiple values for dynamic rules.
 
     [bookmark: pgfId-7267888]Because static NAT rules are one-to-one translations, the Available Ports list contains only port objects and groups that contain only a single port. For static translations, you can add only a single object or literal value to both the Original Port or Translated Port lists.
 
     [bookmark: pgfId-7267696]For dynamic rules, you can add a range of ports. For example, when specifying the original destination port, you can add 1000-1100 as a literal value.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7259743] 
      Caution If a port object or object group is being used by a NAT rule, and you change or delete the object or group, it can cause the rule to become invalid. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7259475]You can add any of the following kinds of port conditions to a NAT rule:
 
      
      	 [bookmark: pgfId-7243779]individual and group port objects that you have created using the object manager
 
     
 
     [bookmark: pgfId-7243783]See Working with Port Objects for information on creating individual and group port objects using the object manager.
 
      
      	 [bookmark: pgfId-7243784]individual port objects that you add from the Destination Ports conditions page, and can then add to your rule and to other existing and future rules
 
     
 
     [bookmark: pgfId-7243788]See Using Objects in NAT Rule Conditions for more information.
 
      
      	 [bookmark: pgfId-7243789]literal port values, consisting of a TCP, UDP, or All (TCP and UDP) transport protocol and a port
 
     
 
     [bookmark: pgfId-7243793]See Adding Literal Conditions to NAT Rules for more information.
 
     [bookmark: pgfId-7259818]The following procedure explains how to add port conditions while adding or editing a NAT rule. See Understanding NAT Rule Conditions and Condition Mechanics for more detailed information.
 
     [bookmark: pgfId-7243808]To add destination port conditions to a NAT rule:
 
     [bookmark: pgfId-7243809]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-7243810]Step 1 Select the Destination Port tab on the rule Edit page.
 
     [bookmark: pgfId-7275976]The Destination Port page appears.
 
     [bookmark: pgfId-7243816]Step 2 Optionally, click the Search by name or value prompt above the Available Ports list, then type a name or value.
 
     [bookmark: pgfId-7243819]The list updates as you type to display matching conditions. See Searching NAT Rule Condition Lists for more information.
 
     [bookmark: pgfId-7243821]Step 3 Click a condition in the Available Ports list. Use the Shift and Ctrl keys to select multiple conditions, or right-click to select all conditions. Note that you can add a maximum of 50 conditions.
 
     [bookmark: pgfId-7243822]Conditions you select are highlighted.
 
     [bookmark: pgfId-7243823]Step 4 You have the following choices:
 
      
       
       	 [bookmark: pgfId-7243824]Click  Add to Original to add the selected port to the Original Ports list.
 
       	 [bookmark: pgfId-7243825]Click  Add to Translated to add the selected port to the Translated Ports list.
 
       	 [bookmark: pgfId-7243826]Drag and drop available ports into a list.
 
      
 
     
 list. 
     
 
     [bookmark: pgfId-7243831]You can identify a single port or a port range in each port object that you add. You can then select objects you added as conditions for your rule. See Using Objects in NAT Rule Conditions for more information.
 
     [bookmark: pgfId-7278518]For static rules, you can use only port objects with single ports.
 
     [bookmark: pgfId-7243838]Step 6 Optionally, to add a literal port select an entry from the Protocol drop-down list beneath the Original Port or Translated Port lists. 
 
     [bookmark: pgfId-7243839]Enter a port, then click Add. You can specify a port number from 0 through 65535. For dynamic rules, you can specify a single port or a range.
 
     [bookmark: pgfId-7243843]The list updates to display your selection. See Adding Literal Conditions to NAT Rules for more information.
 
     [bookmark: pgfId-7243844]Conditions you selected are added
 
     [bookmark: pgfId-7243845]Step 7 Save or continue editing the rule.
 
     [bookmark: pgfId-7229803]You must apply the NAT policy for your changes to take effect; see Applying a NAT Policy.
 
     [bookmark: pgfId-7313323]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7296312]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 54587]Getting Started with Access Control Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1555895]An access control policy determines how the system handles non-fast-pathed traffic on your network. You can configure one or more access control policies, which you can then apply to one or more managed devices. Each device can have one currently applied policy.
 
    [bookmark: pgfId-1584451]The simplest access control policy directs its target devices to handle all traffic using its default action. You can set this default action to block or trust all traffic without further inspection, or to inspect traffic for intrusions and discovery data.
 
    [bookmark: pgfId-1701204]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1636499]Note that only devices deployed inline can affect the flow of traffic. Applying an access control policy configured to block or alter traffic to passively deployed devices can have unexpected results. In some cases, the system prevents you from applying inline configurations to passively deployed devices.
 
    [bookmark: pgfId-1581013]This chapter explains how to create and apply a simple access control policy. It also contains basic information on managing access control policies: editing, updating, comparing, and so on. For more information, see:
 
     
     	 [bookmark: pgfId-1531230]Access Control License and Role Requirements
 
     	 [bookmark: pgfId-1531279]Creating a Basic Access Control Policy
 
     	 [bookmark: pgfId-1626024]Managing Access Control Policies
 
     	 [bookmark: pgfId-1531309]Editing Access Control Policies
 
     	 [bookmark: pgfId-1531331]Understanding Out-of-Date Policy Warnings
 
     	 [bookmark: pgfId-1531353]Applying an Access Control Policy
 
     	 [bookmark: pgfId-1531376]IPS or Discovery-Only Performance Considerations
 
     	 [bookmark: pgfId-1649088]Troubleshooting Access Control Policies and Rules
 
     	 [bookmark: pgfId-1531406]Generating a Report of Current Access Control Settings
 
     	 [bookmark: pgfId-1531436]Comparing Access Control Policies
 
    
 
    [bookmark: pgfId-1581185]A more complex access control policy can blacklist traffic based on Security Intelligence data, as well as use access control rules to exert granular control over network traffic logging and handling. These rules can be simple or complex, matching and inspecting traffic using multiple criteria. Advanced access control policy options control decryption, preprocessing, performance, and other general preferences. 
 
    [bookmark: pgfId-1642870]After you create a basic access control policy, see the following chapters for more information on tailoring it to your deployment:
 
     
     	 [bookmark: pgfId-1557907]Blacklisting Using Security Intelligence IP Address Reputation explains how to immediately blacklist (block) connections based on the latest reputation intelligence.
 
     	 [bookmark: pgfId-1642989]Understanding Traffic Decryption explains how to use an SSL policy to block encrypted traffic without inspecting it, or to pass it on to access control rules, optionally after decrypting it.
 
     	 [bookmark: pgfId-1642993]Understanding Network Analysis and Intrusion Policies explains how network analysis and intrusion policies preprocess and examine packets, as part of the system’s intrusion detection and prevention feature.
 
     	 [bookmark: pgfId-1642997]Tuning Traffic Flow Using Access Control Rules explains how access control rules provide a granular method of handling network traffic across multiple managed devices.
 
     	 [bookmark: pgfId-1557073]Controlling Traffic Using Intrusion and File Policies explains how intrusion and file policies provide the last line of defense before traffic is allowed to its destination, by detecting and optionally blocking intrusions, prohibited files, and malware.
 
    
 
   
 
    
     [bookmark: pgfId-1533028][bookmark: 50093]Access Control License and Role Requirements
 
    [bookmark: pgfId-1558221]Although you can create access control policies regardless of the licenses on your Defense Center, many features require that you enable the appropriate licenses before you apply the policy. Additionally, some features are only available on certain models.
 
    [bookmark: pgfId-1558269]Also note that available access control-related features and actions depend on your user role. The system includes predefined user roles designed for a variety of administrators and analysts, and you can create custom user roles with specialized access privileges.
 
    [bookmark: pgfId-1558226]For more information, see:
 
     
     	 [bookmark: pgfId-1532858]License and Model Requirements for Access Control
 
     	 [bookmark: pgfId-1532906]Managing Your Deployment with Custom User Roles
 
    
 
     
      [bookmark: pgfId-1530919][bookmark: 68674]Lice[bookmark: marker-1533082]nse and Model Requirements for Access Control
 
     [bookmark: pgfId-1531529]Although you can create access control policies regardless of the licenses on your Defense Center, certain aspects of access control require that you enable specific licensed capabilities on target devices before you can apply the policy. Additionally, some features are only available on certain models.
 
     [bookmark: pgfId-1532045]Warning icons and confirmation dialog boxes designate unsupported features for your deployment. For details, hover your pointer over a warning icon and see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-1531541]The following table explains the license and appliance model requirements to apply access control policies. Note that Series 2 devices automatically have most Protection capabilities; you do not have to explicitly enable Protection on those devices.
 
     [bookmark: pgfId-1665643]
 
      
       
        
        [bookmark: pgfId-1672252]Table 12-1 License and Model Requirements for Access Control 
 
        
        
         
         	 
           
           [bookmark: pgfId-1672260]To apply an access control policy that... 
          
  
         	 
           
           [bookmark: pgfId-1672262]License 
          
  
         	 
           
           [bookmark: pgfId-1672267]Supported Defense Centers 
          
  
         	 
           
           [bookmark: pgfId-1672269]Supported Devices 
          
  
        
 
         
         	[bookmark: pgfId-1672271]performs access control based on zone, network, VLAN, or port
 [bookmark: pgfId-1672272]performs URL filtering using literal URLs and URL objects
  
         	[bookmark: pgfId-1672274]Any
  
         	[bookmark: pgfId-1672276]Any
  
         	[bookmark: pgfId-1672278]Any, except:
 
           
           	 [bookmark: pgfId-1672282]Series 2 devices cannot perform URL filtering
 
           	 [bookmark: pgfId-1672286]ASA FirePOWER devices cannot perform VLAN filtering
 
          
  
        
 
         
         	[bookmark: pgfId-1680838]performs SSL inspection; see Table 12-2
  
         	[bookmark: pgfId-1680841]Any
  
         	[bookmark: pgfId-1680846]Any, except the DC500 is limited to network, application, and SSL-related control
  
         	[bookmark: pgfId-1680851]Series 3
  
        
 
         
         	[bookmark: pgfId-1672288]performs access control using geolocation data (source or destination country or continent)
  
         	[bookmark: pgfId-1672293]FireSIGHT
  
         	[bookmark: pgfId-1672298]Any except DC500
  
         	[bookmark: pgfId-1672303]Series 3
Virtual
ASA FirePOWER
  
        
 
         
         	[bookmark: pgfId-1672308]performs intrusion detection and prevention, file control, or Security Intelligence filtering
  
         	[bookmark: pgfId-1672313]Protection
  
         	[bookmark: pgfId-1672315]Any
  
         	[bookmark: pgfId-1672320]Any, except Series 2 devices cannot perform Security Intelligence filtering
  
        
 
         
         	[bookmark: pgfId-1672322]performs advanced malware protection, that is, network-based malware detection and blocking
  
         	[bookmark: pgfId-1672327]Malware
  
         	[bookmark: pgfId-1672332]Any except DC500
  
         	[bookmark: pgfId-1672337]Any except Series 2 or X-Series
  
        
 
         
         	[bookmark: pgfId-1672339]performs user or application control
  
         	[bookmark: pgfId-1672344]Control
  
         	[bookmark: pgfId-1672349]Any, except the DC500 cannot perform user control
  
         	[bookmark: pgfId-1672354]Any except Series 2 or X-Series
  
        
 
         
         	[bookmark: pgfId-1672356]performs URL filtering using category and reputation data
  
         	[bookmark: pgfId-1672361]URL Filtering
  
         	[bookmark: pgfId-1672366]Any except DC500
  
         	[bookmark: pgfId-1672371]Any except Series 2
  
        
 
        
      
 
     
 
      
       
        
        [bookmark: pgfId-1671720]Table 12-2 [bookmark: 11571]License and Model Requirements for SSL Inspection 
 
        
        
         
         	 
           
           [bookmark: pgfId-1671728]To apply an SSL policy that... 
          
  
         	 
           
           [bookmark: pgfId-1671730]License 
          
  
         	 
           
           [bookmark: pgfId-1671735]Supported Defense Centers 
          
  
         	 
           
           [bookmark: pgfId-1671737]Supported Devices 
          
  
        
 
         
         	[bookmark: pgfId-1671739]handles encrypted traffic on the basis of zone, network, VLAN, port, or SSL-related criteria
  
         	[bookmark: pgfId-1671741]Any
  
         	[bookmark: pgfId-1671743]Any
  
         	[bookmark: pgfId-1671748]Series 3
  
        
 
         
         	[bookmark: pgfId-1671750]handles encrypted traffic using geolocation data
  
         	[bookmark: pgfId-1671755]FireSIGHT
  
         	[bookmark: pgfId-1671757]Any except DC500
  
         	[bookmark: pgfId-1671762]Series 3
  
        
 
         
         	[bookmark: pgfId-1671764]handles encrypted traffic using application or user criteria
  
         	[bookmark: pgfId-1671766]Control
  
         	[bookmark: pgfId-1671771]Any, except the DC500 cannot perform user control
  
         	[bookmark: pgfId-1671776]Series 3
  
        
 
         
         	[bookmark: pgfId-1671778]filters encrypted traffic using URL category and reputation data
  
         	[bookmark: pgfId-1671783]URL Filtering
  
         	[bookmark: pgfId-1671788]Any except DC500
  
         	[bookmark: pgfId-1671793]Series 3
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1665646][bookmark: 51594]Managing Your Deployment with Cust[bookmark: marker-1665645]om User Roles
 
     [bookmark: pgfId-1665650]License: feature dependent
 
     [bookmark: pgfId-1532675]As described in Managing Custom User Roles, you can create custom user roles with specialized access privileges. Custom user roles can have any set of menu-based and system permissions, and may be completely original or based on a predefined user role. Custom roles for access control-related features determine whether users can view, modify, and apply access control, intrusion, and file policies, as well as insert or modify rules in the Administrator Rules or Root Rules categories.
 
     [bookmark: pgfId-1532447]The following table shows five example custom roles that determine how FireSIGHT System users interact with access control features. The table lists, in the order they appear when creating custom user roles, the privileges required for each custom role.
 
     [bookmark: pgfId-1655828]
 
      
       
        
        [bookmark: pgfId-1655649]Table 12-3 Example Access Control Custom Roles 
 
        
        
         
         	 
           
           [bookmark: pgfId-1655661]Custom Role Permission 
          
  
         	 
           
           [bookmark: pgfId-1655663]Access Control & SSL Editor 
          
  
         	 
           
           [bookmark: pgfId-1655665]Intrusion & Network Analysis Editor 
          
  
         	 
           
           [bookmark: pgfId-1655667]File Policy Editor 
          
  
         	 
           
           [bookmark: pgfId-1655669]Policy Applier (All) 
          
  
         	 
           
           [bookmark: pgfId-1655671]Intrusion Policy Applier 
          
  
        
 
         
         	[bookmark: pgfId-1655673]Access Control
  
         	[bookmark: pgfId-1655675]yes
  
         	[bookmark: pgfId-1655677]no
  
         	[bookmark: pgfId-1655679]no
  
         	[bookmark: pgfId-1655681]yes
  
         	[bookmark: pgfId-1655683]yes
  
        
 
         
         	[bookmark: pgfId-1655685]Access Control List
  
         	[bookmark: pgfId-1655687]yes
  
         	[bookmark: pgfId-1655689]no
  
         	[bookmark: pgfId-1655691]no
  
         	[bookmark: pgfId-1655693]yes
  
         	[bookmark: pgfId-1655695]yes
  
        
 
         
         	[bookmark: pgfId-1655697]Modify Access Control Policy
  
         	[bookmark: pgfId-1655699]yes
  
         	[bookmark: pgfId-1655701]no
  
         	[bookmark: pgfId-1655703]no
  
         	[bookmark: pgfId-1655705]no
  
         	[bookmark: pgfId-1655707]no
  
        
 
         
         	[bookmark: pgfId-1655709]Apply Intrusion Policies
  
         	[bookmark: pgfId-1655711]no
  
         	[bookmark: pgfId-1655713]no
  
         	[bookmark: pgfId-1655715]no
  
         	[bookmark: pgfId-1655717]yes
  
         	[bookmark: pgfId-1655719]yes
  
        
 
         
         	[bookmark: pgfId-1655721]Apply Access Control Policies
  
         	[bookmark: pgfId-1655723]no
  
         	[bookmark: pgfId-1655725]no
  
         	[bookmark: pgfId-1655727]no
  
         	[bookmark: pgfId-1655729]yes
  
         	[bookmark: pgfId-1655731]no
  
        
 
         
         	[bookmark: pgfId-1655733]Intrusion (also grants network analysis privileges)
  
         	[bookmark: pgfId-1655735]no
  
         	[bookmark: pgfId-1655737]yes
  
         	[bookmark: pgfId-1655739]no
  
         	[bookmark: pgfId-1655741]no
  
         	[bookmark: pgfId-1655743]no
  
        
 
         
         	[bookmark: pgfId-1655745]Intrusion Policy
  
         	[bookmark: pgfId-1655747]no
  
         	[bookmark: pgfId-1655749]yes
  
         	[bookmark: pgfId-1655751]no
  
         	[bookmark: pgfId-1655753]no
  
         	[bookmark: pgfId-1655755]no
  
        
 
         
         	[bookmark: pgfId-1655757]Modify Intrusion Policy
  
         	[bookmark: pgfId-1655759]no
  
         	[bookmark: pgfId-1655761]yes
  
         	[bookmark: pgfId-1655763]no
  
         	[bookmark: pgfId-1655765]no
  
         	[bookmark: pgfId-1655767]no
  
        
 
         
         	[bookmark: pgfId-1655769]File Policy
  
         	[bookmark: pgfId-1655771]no
  
         	[bookmark: pgfId-1655773]no
  
         	[bookmark: pgfId-1655775]yes
  
         	[bookmark: pgfId-1655777]no
  
         	[bookmark: pgfId-1655779]no
  
        
 
         
         	[bookmark: pgfId-1655781]Modify File Policy
  
         	[bookmark: pgfId-1655783]no
  
         	[bookmark: pgfId-1655785]no
  
         	[bookmark: pgfId-1655787]yes
  
         	[bookmark: pgfId-1655789]no
  
         	[bookmark: pgfId-1655791]no
  
        
 
         
         	[bookmark: pgfId-1655793]SSL
  
         	[bookmark: pgfId-1655795]yes
  
         	[bookmark: pgfId-1655797]no
  
         	[bookmark: pgfId-1655799]no
  
         	[bookmark: pgfId-1655801]no
  
         	[bookmark: pgfId-1655803]no
  
        
 
         
         	[bookmark: pgfId-1655805]Modify SSL Policy
  
         	[bookmark: pgfId-1655807]yes
  
         	[bookmark: pgfId-1655809]no
  
         	[bookmark: pgfId-1655811]no
  
         	[bookmark: pgfId-1655813]no
  
         	[bookmark: pgfId-1655815]no
  
        
 
         
         	[bookmark: pgfId-1655817]Apply SSL Policy
  
         	[bookmark: pgfId-1655819]no
  
         	[bookmark: pgfId-1655821]no
  
         	[bookmark: pgfId-1655823]no
  
         	[bookmark: pgfId-1655825]yes
  
         	[bookmark: pgfId-1655827]no
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1655831]Note that you can create and edit network analysis as well as intrusion policies if your FireSIGHT System user account’s role is restricted to Intrusion Policy or Modify Intrusion Policy.
 
     [bookmark: pgfId-1655833]The system renders the web interface differently depending on whether a user can apply full access control policies (including intrusion policies), only intrusion policies, or neither. For example, Intrusion Policies Appliers in the table above can view access control policies and apply intrusion policies but cannot edit either. They also cannot apply access control policies, nor view file or SSL policies. In the web interface in this case:
 
      
      	 [bookmark: pgfId-1591676]the edit icon (
 
      [image: ] ) does not appear on the Access Control Policy page 
     
 
      
      	 [bookmark: pgfId-1532608]the delete icon (
 
      [image: ] ) does not appear on the Access Control Policy page 
     
 
      
      	 [bookmark: pgfId-1655625]the quick-apply pop-up window applies only the intrusion policy
 
      	 [bookmark: pgfId-1655626]access control policy check boxes in the detailed apply pop-up window are disabled
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1655629][bookmark: 94965]Creating a Basic Access Control Policy
 
    [bookmark: pgfId-1530990]License: Any
 
    [bookmark: pgfId-1566200]When you create a new access control policy you must give it a unique name and specify a default action. At this point, the default action determines how the policy’s target devices handles all non-fastpathed traffic; you will add other configurations that affect traffic flow later. Although you are not required to identify the policy targets at creation time, you must perform this step before you can apply the policy.
 
    [bookmark: pgfId-1592636]When you create a new policy, you can set the default action to block all traffic without further inspection, or to inspect traffic for intrusions and discovery data, as shown in the following diagram.
 
    [bookmark: pgfId-1701244]
 
     
     [image: ] 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1663488]Tip When you first create an access control policy, you cannot choose to trust traffic as the default action. If you want to trust all traffic by default, change the default action after you create the policy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1663489]Use the Access Control Policy page (Policies > Access Control) to create new and manage existing access control policies. Depending on whether and how you registered devices to the Defense Center, either of two predefined access control policies might appear and already be applied to your devices:
 
     
     	 [bookmark: pgfId-1566206]The Default Access Control policy blocks all traffic without further inspection.
 
     	 [bookmark: pgfId-1566207]The Default Intrusion Prevention policy allows all traffic, but also inspects with the Balanced Security and Connectivity intrusion policy and default intrusion variable set.
 
    
 
    [bookmark: pgfId-1692381]You can use and modify either of these access control policies. Note that neither of these default policies has logging enabled.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1692416] 
     Caution Applying an access control policy for the first time restarts the Snort process, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1692382]To create an access control policy:
 
    [bookmark: pgfId-1692386]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1663480]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1663481]The Access Control Policy page appears.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1533389]Step 2 Click New Policy.
 
   [bookmark: pgfId-1533390]The New Access Control Policy pop-up window appears.
 
   [bookmark: pgfId-1533391]Step 3 Give the policy a unique Name and, optionally, a Description.
 
   [bookmark: pgfId-1533392]You can use all printable characters, including spaces and special characters, except for the pound sign (#), a semi-colon (;), or either brace ({}). The name must include at least one non-space character.
 
   [bookmark: pgfId-1533709]Step 4 Specify the initial Default Action:
 
    
     
     	 [bookmark: pgfId-1533710] Block all traffic creates a policy with the  Access Control: Block All Traffic default action.
 
     	 [bookmark: pgfId-1533711] Intrusion Prevention creates a policy with the  Intrusion Prevention: Balanced Security and Connectivity default action.
 
     	 [bookmark: pgfId-1533393] Network Discovery creates a policy with the  Network Discovery Only default action.
 
    
 
   
 
   [bookmark: pgfId-1533612]For guidance on choosing an initial default action, as well as how to change it later, see Setting Default Handling and Inspection for Network Traffic.
 
   [bookmark: pgfId-1533394]Step 5 Select the Available Devices where you want to apply the policy. 
 
   [bookmark: pgfId-1565973]Use Ctrl and Shift to select multiple devices, or right-click to Select All. To narrow the devices that appear, type a search string in the Search field. If you skip adding target devices, see Setting Target Devices for an Access Control Policy for information on adding them later.
 
   [bookmark: pgfId-1565316]Step 6 Click Add to Policy to add the selected devices. 
 
   [bookmark: pgfId-1565312]You can also drag and drop selected objects.
 
   [bookmark: pgfId-1533400]Step 7 Click Save.
 
   [bookmark: pgfId-1581216]The access control policy editor appears. For information on configuring your new policy, see Editing Access Control Policies. Note that you must apply the policy for it to take effect; see Applying an Access Control Policy.
 
   [bookmark: pgfId-1611899]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1581225][bookmark: 56491]Setting Default Handling and Inspection for Network Traffic
 
    [bookmark: pgfId-1531016]License: Any
 
    [bookmark: pgfId-1559622]When you create an access control policy, you must select a default action. The default action for an access control policy determines how the system handles traffic that:
 
     
     	 [bookmark: pgfId-1534055]is not blacklisted by Security Intelligence
 
     	 [bookmark: pgfId-1673917]is not blocked by SSL inspection (encrypted traffic only)
 
     	 [bookmark: pgfId-1564806]matches none of the rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic)
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1599193]The following table describes how the different default actions handle traffic, and lists the types of inspection you can perform on traffic handled by each default action. Note that you cannot perform file or malware inspection on traffic handled by the default action. For more information, see Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-1534101]:
 
     
      
       
       [bookmark: pgfId-1559917]Table 12-4 [bookmark: 43759]Access Control Policy Default Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1559923]Default Action 
         
  
        	 
          
          [bookmark: pgfId-1559925]Effect on Traffic 
         
  
        	 
          
          [bookmark: pgfId-1559927]Inspection Type and Policy 
         
  
       
 
        
        	[bookmark: pgfId-1559929]Access Control: Block All Traffic
  
        	[bookmark: pgfId-1559931]block without further inspection
  
        	[bookmark: pgfId-1559933]none
  
       
 
        
        	[bookmark: pgfId-1559935]Access Control: Trust All Traffic
  
        	[bookmark: pgfId-1559937]trust (allow to its final destination without further inspection)
  
        	[bookmark: pgfId-1559939]none
  
       
 
        
        	[bookmark: pgfId-1575248][bookmark: marker-1575247]Intrusion Prevention
  
        	[bookmark: pgfId-1575250]allow, as long as it is passed by the intrusion policy you specify (requires Protection)
  
        	[bookmark: pgfId-1575255]intrusion, using the specified intrusion policy and associated variable set, and
 [bookmark: pgfId-1575256]discovery, using the network discovery policy
  
       
 
        
        	[bookmark: pgfId-1559942][bookmark: marker-1559941]Network Discovery Only
  
        	[bookmark: pgfId-1559944]allow
  
        	[bookmark: pgfId-1559946]discovery only, using the network discovery policy
  
       
 
       
     
 
    
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1599257]Tip The purpose of Network Discovery Only is to improve performance in a discovery-only deployment. Different configurations can disable discovery if you are only interested in intrusion detection and prevention. See IPS or Discovery-Only Performance Considerations for more information, including other guidelines you must follow.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1562345]When you first create an access control policy, logging connections that are handled by the default action is disabled by default. If you select a default action that performs intrusion inspection, the system automatically associates the default intrusion variable set with the intrusion policy you select. You can change either of these options, as well as the default action itself, after you create the policy.
 
    [bookmark: pgfId-1534136]To change an access control policy’s default action and related options:
 
    [bookmark: pgfId-1663471]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1663472]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1663473]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1534144]The access control policy editor appears.
 
    [bookmark: pgfId-1534145]Step 3 Select a Default Action.
 
     
      
      	 [bookmark: pgfId-1534146]To block all traffic, select  Access Control: Block All Traffic .
 
      	 [bookmark: pgfId-1534147]To trust all traffic, select  Access Control: Trust All Traffic .
 
      	 [bookmark: pgfId-1534148]To allow all traffic and inspect it with network discovery, select  Network Discovery Only .
 
      	 [bookmark: pgfId-1534149]To inspect all traffic with both network discovery and intrusion policies, select an intrusion policy, all of which begin with the label Intrusion Prevention . Keep in mind that an intrusion policy can block traffic.
 
     
 
    
 ) to change the variable set associated with the intrusion policy you selected. 
    
 ). If you do not change the variable set, the system uses a default set. For more information, see 
    Working with Variable Sets. 
    
 ) to change logging options for connections handled by the default action. 
    
 
    [bookmark: pgfId-1563423]Depending on the default action, you can log a matching connection at its beginning, end, or both. You can log connections to the Defense Center database, external system log (syslog), or SNMP trap server. For more information, see Logging Connections Handled by the Access Control Default Action.
 
    [bookmark: pgfId-1611953]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1530923][bookmark: 96544]Setting Target Devices for an Access Control Pol[bookmark: marker-1565994]icy
 
    [bookmark: pgfId-1531028]License: Any
 
    [bookmark: pgfId-1566036]Before you can apply an access control policy you must identify the managed devices where you want to apply the policy. You can identify the devices you want to target with your policy while creating a policy, or you can add them later.
 
     
     
 
     
 
      
       
       [bookmark: pgfId-1597571]Table 12-5 [bookmark: 34972]Targeted Device Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1597575]To... 
         
  
        	 
          
          [bookmark: pgfId-1597577]You can... 
         
  
       
 
        
        	[bookmark: pgfId-1597579]search a list of available devices
  
        	[bookmark: pgfId-1597581]click inside the search field, then type a search string. The list of devices updates as you type to display matching device names.
  
       
 
        
        	[bookmark: pgfId-1597583]clear a search for available devices
  ) in the search field. 
       
 
        
        	[bookmark: pgfId-1597590]select available devices to add to the list of selected targets
  
        	[bookmark: pgfId-1597592]click the device name; use the Ctrl and Shift keys to select multiple devices. You can also right-click an available device, then click Select All.
  
       
 
        
        	[bookmark: pgfId-1597595]add selected devices
  
        	[bookmark: pgfId-1597597]click Add to Policy or drag and drop into the list of selected devices.
  
       
 
        
        	[bookmark: pgfId-1597600]delete a single device from the Selected Devices list
  . 
       
 
        
        	[bookmark: pgfId-1597608]delete multiple devices from the Selected Devices list
  
        	[bookmark: pgfId-1597610]use the Ctrl and Shift keys to select multiple devices, right-click to highlight the row for a selected device, then click Delete Selected. 
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1599522]Note that you cannot target stacked devices running different versions of the system (for example, if an upgrade on one of the devices fails). You can target a device stack, but not individual devices within the stack. See Managing Stacked Devices for more information.
 
    [bookmark: pgfId-1565547]To manage targeted devices in an access control policy:
 
    [bookmark: pgfId-1663447]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1663448]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1663449]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1644503]The access control policy editor appears.
 
    [bookmark: pgfId-1565556]Step 3 Click the device targets link, then click Manage Targets.
 
    [bookmark: pgfId-1565557]The Manage Device Targets pop-up window appears.
 
    [bookmark: pgfId-1565558]Step 4 Build your target list.
 
    [bookmark: pgfId-1599315]Use the actions summarized in Table 12-5.
 
    [bookmark: pgfId-1630405]Step 5 Click OK.
 
    [bookmark: pgfId-1630406]Your configuration is added to the policy and the access control policy editor appears.
 
    [bookmark: pgfId-1630407]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1625752][bookmark: 13111]Managing Access Control Pol[bookmark: marker-1625751]icies
 
    [bookmark: pgfId-1625759]License: Any
 
    [bookmark: pgfId-1663429]On the Access Control Policy page (Policies > Access Control) you can view your current custom access control policies, along with the following information, when appropriate:
 
     
     	 [bookmark: pgfId-1625763]the number of devices using each access control policy to inspect traffic, including information on whether a policy is applied to only some of its targets, or is applied to a device not currently targeted by that policy
 
     	 [bookmark: pgfId-1625764]the number of targeted devices where each policy is out of date, as well as information about who (if anyone) is currently editing each policy
 
    
 
    [bookmark: pgfId-1640350]In addition to custom policies that you create, the system can provide three custom policies: Default Access Control, Default Intrusion Prevention, and Default Network Discovery. The system creates these policies during initial device registration, depending on the detection modes you selected for your devices during their initial configuration. You can edit and use these system-provided custom policies. Note that a device’s detection mode is not a setting you can change later; it is simply an option you choose during setup that helps the system tailor that device’s initial configurations.
 
    [bookmark: pgfId-1625766]Options on the Access Control Policy page allow you to take the actions in the following table.
 
    [bookmark: pgfId-1625862]
 
     
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1625773]Table 12-6 [bookmark: 22107]Access Control Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1625779]To... 
         
  
        	 
          
          [bookmark: pgfId-1625781]You can... 
         
  
        	 
          
          [bookmark: pgfId-1625783]See... 
         
  
       
 
        
        	[bookmark: pgfId-1625785]create a new access control policy
  
        	[bookmark: pgfId-1625787]click New Policy.
  
        	[bookmark: pgfId-1625792]Creating a Basic Access Control Policy
  
       
 
        
        	[bookmark: pgfId-1625794]edit an existing access control policy
  ). 
        	[bookmark: pgfId-1625804]Editing Access Control Policies
  
       
 
        
        	[bookmark: pgfId-1625806]reapply an access control policy to your managed devices
  ). 
        	[bookmark: pgfId-1625816]Applying an Access Control Policy
  
       
 
        
        	[bookmark: pgfId-1625818]export an access control policy to import on another Defense Center
  ) 
        	[bookmark: pgfId-1625831]Exporting Configurations
  
       
 
        
        	[bookmark: pgfId-1625833]view a PDF report that lists the current configuration settings in a access control policy
  ). 
        	[bookmark: pgfId-1625842]Generating a Report of Current Access Control Settings
  
       
 
        
        	[bookmark: pgfId-1625845]compare access control policies
  
        	[bookmark: pgfId-1625847]click Compare Policies.
  
        	[bookmark: pgfId-1625851]Comparing Access Control Policies
  
       
 
        
        	[bookmark: pgfId-1625854]delete an access control policy
  
        	 ), then confirm that you want to delete the policy. You cannot delete an applied access control policy or one that is currently applying.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1530924][bookmark: 81356]Editing Access Control Policies
 
    [bookmark: pgfId-1629623]License: Any
 
    [bookmark: pgfId-1674072]When you first create a new access control policy, the access control policy editor appears, focused on the Rules tab. The following graphic shows a newly created policy. Because a new policy does not yet have rules or other configurations, the default action handles all traffic. In this case, the default action inspects unencrypted traffic with the system-provided Balanced Security and Connectivity intrusion policy before allowing it to its final destination. Note that by default, the system disables file and intrusion inspection on encrypted payloads.
 
    [bookmark: pgfId-1701340]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1586188]Use the access control policy editor to add and organize rules, specify the devices that will use the policy, and so on. The following list provides information on the policy configurations you can change.
 
    [bookmark: pgfId-1587569]Name and Description
 
    [bookmark: pgfId-1587542]To change the policy’s name and description, click the appropriate field and type the new name or description.
 
    [bookmark: pgfId-1586209]Targets
 
    [bookmark: pgfId-1586211]Before you can apply an access control policy, use the Targets tab to identify the managed devices, including device groups, where you want to apply the policy. For more information, see Setting Target Devices for an Access Control Policy.
 
    [bookmark: pgfId-1586216]Security Intelligence
 
    [bookmark: pgfId-1586218]Security Intelligence is a first line of defense against malicious Internet content. This feature allows you to immediately blacklist (block) connections based on the latest reputation intelligence. To ensure continual access to vital resources, you can override blacklists with custom whitelists. This traffic filtering takes place before any other policy-based inspection, analysis, or traffic handling, including rules and the default action. For more information, see Blacklisting Using Security Intelligence IP Address Reputation.
 
    [bookmark: pgfId-1587344]Rules
 
    [bookmark: pgfId-1587345]Rules provide a granular method of handling network traffic. Rules in an access control policy are numbered, starting at 1. The system matches traffic to access control rules in top-down order by ascending rule number.
 
    [bookmark: pgfId-1633555]In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. These conditions include security zone, network or geographical location, VLAN, port, application, requested URL, or user. Conditions can be simple or complex; their use often depends on certain licenses and appliance models. 
 
    [bookmark: pgfId-1633556]Use the Rules tab to add, categorize, enable, disable, filter, and otherwise manage rules. For more information, see Tuning Traffic Flow Using Access Control Rules.
 
    [bookmark: pgfId-1587430]Default Action
 
    [bookmark: pgfId-1587431]The default action determines how the system handles traffic that is not blacklisted by Security Intelligence and does not match any access control rules. Using the default action, you can block or trust all traffic without further inspection, or inspect traffic for intrusions and discovery data. You can also select an custom variable set if you have created one, and enable or disable logging of connections handled by the default action.
 
    [bookmark: pgfId-1587434]For more information, see Setting Default Handling and Inspection for Network Traffic and Logging Connections Based on Access Control Handling.
 
    [bookmark: pgfId-1586223]HTTP Responses
 
    [bookmark: pgfId-1586225]You can specify what the user sees in a browser when the system blocks that user’s website request—either display a generic system-provided response page, or enter custom HTML. You can also display a page that warns users, but also allows them to click a button to continue or refresh the page to load the originally requested site. For more information, see Displaying a Custom Web Page for Blocked URLs.
 
    [bookmark: pgfId-1586227]Advanced Access Control Options
 
    [bookmark: pgfId-1586229]Advanced access control policy settings typically require little or no modification. The default settings are appropriate for most deployments. Advanced settings you can modify include:
 
    [bookmark: pgfId-1613970] – the number of characters you store in the Defense Center database for each URL requested by your users; see Logging URLs Detected in Connections
 
    [bookmark: pgfId-1674846] – the length of time before you re-block a website after a user bypasses an initial block; see Setting the User Bypass Timeout for a Blocked Website
 
    [bookmark: pgfId-1674850] – an SSL policy to monitor, decrypt, block, or allow application layer protocol traffic encrypted with Secure Socket Layer (SSL) or Transport Layer Security (TLS); see Applying Decryption Settings Using Access Control
 
    [bookmark: pgfId-1613719] – allow traffic inspection during policy apply or disable traffic inspection for secure connectivity; see Applying an Access Control Policy
 
    [bookmark: pgfId-1681820] – network analysis and intrusion policy settings that allow you to tailor many preprocessing options to networks, zones, and VLANs, as well as set default intrusion inspection behavior; see Customizing Traffic Preprocessing
 
    [bookmark: pgfId-1586426] – advanced transport and network preprocessor settings that apply globally to all networks, zones, and VLANs where you apply the access control policy; see Configuring Advanced Transport/Network Settings
 
    [bookmark: pgfId-1614178] – adaptive profiles to improve reassembly of packet fragments and TCP streams in passive deployments, based on your network’s host operating systems; see Tuning Preprocessing in Passive Deployments
 
    [bookmark: pgfId-1586428] – performance options for intrusion inspection, file control, file storage, dynamic analysis, and advanced malware protection; see Tuning Intrusion Prevention Performance and Tuning File and Malware Inspection Performance and Storage
 
    [bookmark: pgfId-1576329]When you edit an access control policy, a message indicates that you have unsaved changes. To retain your changes, you must save the policy before exiting the policy editor. If you attempt to exit the policy editor without saving your changes, you are cautioned that you have unsaved changes; you can then discard your changes and exit the policy, or return to the policy editor.
 
    [bookmark: pgfId-1576330]To protect the privacy of your session, after sixty minutes of inactivity on the policy editor, changes to your policy are discarded and you are returned to the Access Control Policy page. After the first thirty minutes of inactivity, a message appears and updates periodically to provide the number of minutes remaining before changes are discarded. Any activity on the page cancels the timer.
 
    [bookmark: pgfId-1576331]When you attempt to edit the same policy in two browser windows, you are prompted whether to resume your edit in the new window, discard your changes in the original window and continue editing in the new window, or cancel the second window and return to the policy editor.
 
    [bookmark: pgfId-1576332]When multiple users edit the same policy concurrently, a message for each on the policy editor identifies other users who have unsaved changes. Any user who attempts to save their changes is cautioned that their changes will overwrite changes by other users. When the same policy is saved by multiple users, the last saved changes are retained.
 
    [bookmark: pgfId-1576400]To edit an access control policy:
 
    [bookmark: pgfId-1663423]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1663424]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1663425]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1576408]The access control policy editor appears.
 
    [bookmark: pgfId-1576409]Step 3 Edit your policy. Take any of the actions summarized above. 
 
    [bookmark: pgfId-1576424]Step 4 Save or discard your configuration:
 
     
      
      	 [bookmark: pgfId-1576425]To save your changes and continue editing, click  Save. 
 
      	 [bookmark: pgfId-1576426]To save your changes and apply your policy, click  Save and Apply . See Applying an Access Control Policy.
 
      	 [bookmark: pgfId-1576431]To discard your changes, click  Cancel and, if prompted, click  OK .
 
     
 
    
 
    [bookmark: pgfId-1611980]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1575908][bookmark: 63505]Understanding Out-of-Date Policy Warnings
 
    [bookmark: pgfId-1663412]License: Any
 
    [bookmark: pgfId-1663413]On the Access Control Policy page (Policies > Access Control), out-of-date policies are marked with red status text that indicates how many of its targeted devices need a policy update.
 
    [bookmark: pgfId-1633872]In almost every case, whenever you change an access control policy, you must reapply it for the change to take effect. If the access control policy invokes other policies or relies on other configurations, changing those also requires that you reapply the access control policy (or, for intrusion policy changes, you can reapply just the intrusion policy). 
 
    [bookmark: pgfId-1572040]Configuration changes that require a policy reapply include:
 
     
     	 [bookmark: pgfId-1572041]Modifying the access control policy itself: any changes to access control rules, the default action, policy targets, Security Intelligence filtering, advanced options including NAP rules, and so on.
 
     	 [bookmark: pgfId-1572042]Changing any of the policies that the access control policy invokes: the SSL policy, network analysis policies, intrusion policies, and file policies.
 
     	 [bookmark: pgfId-1633843]Changing any reusable object or configuration used in the access control policy or the policies it invokes: network, port, VLAN tag, URL, and geolocation objects; Security Intelligence lists and feeds; application filters or detectors; intrusion policy variable sets; file lists; decryption-related objects, security zones, and so on. 
 
     	 [bookmark: pgfId-1572044]Updating the system software, intrusion rules, or the vulnerability database (VDB).
 
    
 
    [bookmark: pgfId-1572045]Keep in mind that you can change some of these configurations from multiple places in the web interface. For example, you can modify security zones using the object manager (Objects > Object Management), but modifying an interface type in a device’s configuration (Devices > Device Management) can also change a zone and require a policy reapply.
 
    [bookmark: pgfId-1572046]Note that the following updates do not require policy reapply:
 
     
     	 [bookmark: pgfId-1572047]automatic updates to Security Intelligence feeds and additions to the Security Intelligence global blacklist or whitelist using the context menu
 
     	 [bookmark: pgfId-1572048]automatic updates to URL filtering data
 
     	 [bookmark: pgfId-1572049]scheduled geolocation database (GeoDB) updates
 
    
 
    [bookmark: pgfId-1573296]To determine why an access control or intrusion policy is out of date, use the comparison viewer.
 
    [bookmark: pgfId-1572050]To determine why an access control policy is out of date:
 
    [bookmark: pgfId-1663400]Access: Admin/Security Approver
 
    
 
    [bookmark: pgfId-1663401]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1663402]The Access Control Policy page appears. Policies that are out of date are marked with red status text that indicates how many of its targeted devices need a policy update.
 
    [bookmark: pgfId-1573464]Step 2 Click the policy status for an out-of-date policy.
 
    [bookmark: pgfId-1573465]The detailed Apply Access Control Policy pop-up window appears.
 
    [bookmark: pgfId-1572056]Step 3 Click Out-of-date next to the changed component you are interested in.
 
    [bookmark: pgfId-1572057]A policy comparison report appears in a new window. For more information, see Comparing Access Control Policies and Comparing Two Intrusion Policies or Revisions.
 
    [bookmark: pgfId-1572101]Step 4 Optionally, reapply the policy.
 
    [bookmark: pgfId-1572134]See the next section, Applying an Access Control Policy.
 
    [bookmark: pgfId-1612000]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1530926][bookmark: 20491]Appl[bookmark: marker-1635066]ying an Access Control Policy
 
    [bookmark: pgfId-1531070]License: Any
 
    [bookmark: pgfId-1681013]After you change an access control policy, you must apply the policy to one or more target devices to implement the change on the networks monitored by the devices. Although you can apply any combination of an access control policy and its associated intrusion policies, applying an access control policy automatically applies all associated SSL, network analysis, and file policies. You cannot apply these policies independently.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1687580] 
     Caution When you apply an access control policy, resource demands may result in a small number of packets dropping without inspection. Additionally, applying some configurations requires the Snort process to restart, which temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1681312]Tip If you a[bookmark: marker-1681308]re using Cisco NGIPS for Blue Coat X-Series deployed inline and you configure a multi-VAP VAP group for load-balancing and redundancy, you can avoid processing pauses by removing the affected VAP from the load-balanced list until the device restarts, then reinstate it.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1644403]Note that only devices deployed inline can affect the flow of traffic. Applying an access control policy configured to block or alter traffic to passively deployed devices can have unexpected results. For example, because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection. 
 
    [bookmark: pgfId-1644404]In some cases, the system prevents you from applying inline configurations to passively deployed devices, including inline devices in tap mode. For example, in an passive deployment, you cannot apply an access control policy that references an SSL policy that blocks encrypted traffic, or that is configured to re-sign decrypted traffic. Also, passive deployments do not support decrypting traffic encrypted with the ephemeral Diffie-Hellman (DHE) or the elliptic curve Diffie-Hellman (ECDHE) cipher suites. 
 
    [bookmark: pgfId-1636348]Keep the following additional points in mind when applying access control policies:
 
     
     	 [bookmark: pgfId-1636349]Some features require specific licenses, minimum versions of the system, or specific device models. For more information, see License and Model Requirements for Access Control, as well as the release notes for the version of the system you are running on your managed devices. If an access control policy requires licenses enabled through recently applied device configurations, the system queues the access control policy apply until the device configurations finish applying.
 
     	 [bookmark: pgfId-1635097]You cannot apply an access control policy to stacked devices running different versions of the system (for example, if an upgrade on one of the devices fails).
 
     	 [bookmark: pgfId-1683547]When you apply an access control policy, the system evaluates all the rules together and creates an expanded set of criteria that target devices use to evaluate network traffic. A pop-up window may warn that you have exceeded the maximum number of access control rules or intrusion policies supported by a target device. This maximum depends on a number of factors, including the physical memory and the number of processors on the device. On devices with less computing resources, note that limited memory may require that you select as few as three intrusion policies across an entire access control policy. For more information, see Simplifying Rules to Improve Performance.
 
     	 [bookmark: pgfId-1635122]If you are performing application control, at least one detector must be enabled for each application used as a criterion in either an access control or SSL rule. If no detector is enabled for an application, the system automatically enables all system-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.
 
     	 [bookmark: pgfId-1664696]When you import an intrusion rule update, you can automatically reapply access control and intrusion policies after the import completes. This allows you to use the most up-to-date intrusion rules and advanced settings, as well as preprocessor rules and preprocessor settings. This is especially useful if you allow rule updates to modify system-provided base policies. Note that rule updates can also modify default values for the advanced preprocessing and performance options in your access control policies. For more information, see Importing Rule Updates and Local Rule Files.
 
     	 [bookmark: pgfId-1685044]On devices with limited memory, the number of intrusion policies may not be paired with more than one variable set. In the case where you can apply an access control policy that references only one intrusion policy, verify every reference to the intrusion policy is paired with the same variable set.
 
    
 
    [bookmark: pgfId-1635124]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1635128]Applying a Complete Policy explains how to use the quick-apply option to apply the access control policy along with all associated SSL, network analysis, intrusion, and file policies.
 
     	 [bookmark: pgfId-1537296]Applying Selected Policy Configurations explains how to apply specific access control policy configurations, including individual intrusion policies.
 
    
 
     
      [bookmark: pgfId-1530927][bookmark: 39078]Applying a Complete Policy
 
     [bookmark: pgfId-1536673]License: Any
 
     [bookmark: pgfId-1536684]Supported Devices: 
 
     [bookmark: pgfId-1536816]You can apply an access control policy to its target devices at any time. Applying an access control policy also applies any associated policies that are different from those currently running:
 
      
      	 [bookmark: pgfId-1536885]SSL policy
 
      	 [bookmark: pgfId-1536981]network analysis policies
 
      	 [bookmark: pgfId-1536943]intrusion policies
 
      	 [bookmark: pgfId-1537030]file policies
 
     
 
     [bookmark: pgfId-1536899]A pop-up window allows you to apply all together as a single quick-apply action. Unchanged policies are not applied when you use the quick-apply option.
 
     [bookmark: pgfId-1536818]The label for the apply button on the quick-apply pop-up window can differ depending on whether you are permitted to apply an access control policy, intrusion policy, or both; see Managing Your Deployment with Custom User Roles.
 
     [bookmark: pgfId-1536822]To quick-apply a complete access control policy:
 
     [bookmark: pgfId-1663388]Access: Admin/Security Approver
 
     
 
     [bookmark: pgfId-1663389]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1663390]The Access Control Policy page appears.
 ) next to the policy you want to apply. 
     
 
     [bookmark: pgfId-1536830]The Apply Access Control Policy pop-up window appears.
 
     [bookmark: pgfId-1536833]Alternatively, you can click Save and Apply while editing a policy; see Editing Access Control Policies.
 
     [bookmark: pgfId-1536835]Step 3 Click Apply All.
 
     [bookmark: pgfId-1681702]Your policy apply task is queued. Click OK to return to the Access Control Policy page. You can monitor the progress of the policy apply task on the Task Status page (System > Monitoring > Task Status).
 
     [bookmark: pgfId-1612006]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1536674][bookmark: 71530]Applying Selected Policy Configurations
 
     [bookmark: pgfId-1536675]License: Any
 
     [bookmark: pgfId-1537258]You can use the detailed policy apply page to apply changes to your access control policy and to any associated intrusion policies. The detailed page lists each device targeted by the policy and provides a column for the access control policy by device, and a column for associated intrusion policies by device. You can specify whether to apply changes to an access control policy, to associated intrusion policies individually or in combination, or both, for each targeted device.
 
     [bookmark: pgfId-1536700]You must apply both an access control policy and an associated intrusion policy in either of the following cases:
 
      
      	 [bookmark: pgfId-1536701]when the access control policy is being applied to the device for the first time
 
      	 [bookmark: pgfId-1536702]when an intrusion policy has been newly added to the access control policy
 
     
 
     [bookmark: pgfId-1536703]In both cases, the states of the access control policy and the intrusion policies are linked; that is, you must apply both or neither.
 
     [bookmark: pgfId-1536704]Note that regardless of the intrusion policies you apply, applying an access control policy automatically applies all associated SSL, network analysis, and file policies that are different from those currently running on devices targeted by the policy. You cannot apply these policies independently. 
 
     [bookmark: pgfId-1536706][bookmark: 24854]The Access Control Policy Column
 
     [bookmark: pgfId-1536707]The Access Control Policy column provides a check box for indicating whether to apply the access control policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-1536708]Tip Although you can reapply a policy while it is still in the task queue, that is, while the apply task has not yet completed, there is no benefit in doing this.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1536709]A status message indicates whether the policy is currently up to date or out of date. When the policy is out of date, you can conveniently display a comparison of the policy to the currently running policy in a new browser window. The comparison does not include differences in an intrusion policy associated with the access control policy. 
 
     [bookmark: pgfId-1536711][bookmark: 56083]The Intrusion Policies Column
 
     [bookmark: pgfId-1536712]The Intrusion Policies column provides one or more check boxes for indicating whether to apply intrusion policies associated with the access control policy to a device. A single grayed check box indicates that all associated intrusion policies are identical to currently running policies, in which case the check box is cleared and cannot be selected. You cannot apply an unchanged intrusion policy; only changed intrusion policies are listed, and can be selected individually. When the same intrusion policy is associated with multiple rules in a policy, the intrusion policy is listed only once for each device.
 
     [bookmark: pgfId-1536713]The check box for an intrusion policy is selected and the check box is grayed and cannot be changed when the access control policy and the intrusion policy must be applied together, as described above, in either of the following cases:
 
      
      	 [bookmark: pgfId-1536714]when the access control policy is being applied to the device for the first time
 
      	 [bookmark: pgfId-1536715]when an intrusion policy has been newly added to the access control policy
 
     
 
     [bookmark: pgfId-1573806]Status messages indicate whether intrusion policies are currently up to date or out of date. An intrusion policy is out of date when it is not identical to an intrusion policy currently running on the listed device. An identical intrusion policy on the device is up to date. When the policy is out of date, you can conveniently display a comparison of the policy to the currently running policy in a new browser window.
 
     [bookmark: pgfId-1573807]To apply selected access control policy configurations:
 
     [bookmark: pgfId-1663380]Access: Admin/Security Approver
 
     
 
     [bookmark: pgfId-1663381]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1663382]The Access Control Policy page appears.
 ) next to the policy you want to apply. 
     
 
     [bookmark: pgfId-1633810]The Apply Access Control Policy pop-up window appears.
 
     [bookmark: pgfId-1633813]Alternatively, you can click Save and Apply while editing a policy; see Editing Access Control Policies.
 
     [bookmark: pgfId-1536730]Step 3 Click Details.
 
     [bookmark: pgfId-1663374]The detailed Apply Access Control Policy pop-up window appears. Note that you can also open the pop-up window from the Access Control Policy page (Policies > Access Control) by clicking on an out-of-date message in the Status column for the policy.
 
     [bookmark: pgfId-1536733]Step 4 Select or clear the access control policy check box next to the device name to specify whether to apply the access control policy to a targeted device.
 
     [bookmark: pgfId-1536734]Step 5 Select or clear the intrusion policy check box next to the device name to specify whether to apply an intrusion policy to a targeted device. 
 
     [bookmark: pgfId-1536754]Step 6 Click Apply Selected Configurations.
 
     [bookmark: pgfId-1573855]Your policy apply task is queued. Click OK to return to the Access Control Policy page.
 
     [bookmark: pgfId-1573957]Note that a pop-up window may warn that you have exceeded the maximum number of intrusion policies supported by the device. You must reevaluate your access control policy and consolidate intrusion policies. You cannot apply the access control policy until the number of associated intrusion policies (including the default action) falls within the maximum.
 
     [bookmark: pgfId-1681804]You can monitor the progress of the policy apply task on the Task Status page (System > Monitoring > Task Status).
 
     [bookmark: pgfId-1612022]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1687992][bookmark: 73334]Traffic Inspection During Access Control Policy Apply
 
      
      	 [bookmark: pgfId-1691048]When you enable  Inspect traffic during policy apply :
 
     
 
     [bookmark: pgfId-1691104] – Certain configurations can require the Snort process to restart.
 
     [bookmark: pgfId-1691190] – When the configurations you apply do not require a Snort restart, the system initially uses the currently applied access control policy to inspect traffic, and switches during the application process to the policy you are applying
 
      
      	 [bookmark: pgfId-1691710]When you disable  Inspect traffic during policy apply , the Snort process always restarts when you apply the policy.
 
      	 [bookmark: pgfId-1691802]How a Snort restart affects traffic depends on the model of the managed device and how it handles traffic. See How Snort Restarts Affect Traffic.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1690112][bookmark: 31246]IPS or Discovery-Only Performance Considerations
 
    [bookmark: pgfId-1649532]License: FireSIGHT or Protection
 
    [bookmark: pgfId-1649539]A FireSIGHT license is included with your Defense Center and allows you to perform host, application, and user discovery. Discovery data allows the system to create a complete, up-to-the-minute profile of your network. With Protection licenses applied to your managed devices, the system can act as an intrusion detection and prevention system (IPS). You can analyze network traffic for intrusions and exploits and, optionally, drop offending packets. 
 
    [bookmark: pgfId-1649543]Combining discovery and IPS gives context to your network activity and allows you to take advantage of many features, including:
 
     
     	 [bookmark: pgfId-1649544]impact flags and indications of compromise, which can tell you which of your hosts are vulnerable to a particular exploit, attack, or piece of malware
 
     	 [bookmark: pgfId-1649548]adaptive profiles and FireSIGHT recommendations, which allow you to examine traffic differently depending on the destination host
 
     	 [bookmark: pgfId-1649549]correlation, which allows you to respond to intrusions (and other events) differently depending on the affected host
 
    
 
    [bookmark: pgfId-1649550]However, if your organization is interested in performing only IPS, or only discovery, there are a few configurations that can optimize the performance of the system, as described in the following sections:
 
     
     	 [bookmark: pgfId-1649554]Optimizing a Network Discovery-Only Deployment
 
     	 [bookmark: pgfId-1649558]Performing Intrusion Detection and Prevention without Discovery
 
    
 
     
      [bookmark: pgfId-1649560][bookmark: 10375]Optimizing a Network Discovery-Only Deployment
 
     [bookmark: pgfId-1649567]License: FireSIGHT
 
     [bookmark: pgfId-1649568]The discovery feature allows you to monitor network traffic and determine the number and types of hosts (including network devices) on your network, as well as the operating systems, active applications, and open ports on those hosts. You can also configure managed devices and User Agents to monitor user activity on your network. You can use discovery data to perform traffic profiling, assess network compliance, and respond to policy violations.
 
     [bookmark: pgfId-1649569]In a basic deployment (discovery and simple, network-based access control only), you can improve a device’s performance by following a few important guidelines when configuring its access control policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-1649570]Note You must apply an access control policy, even if it simply allows all traffic. The network discovery policy can only examine traffic that the access control policy allows to pass.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1649571]First, make sure your access control policy does not require complex processing and uses only simple, network-based criteria to handle network traffic. You must implement all of the following guidelines; misconfiguring any one of these options eliminates the performance benefit:
 
      
      	 [bookmark: pgfId-1649572]Do  not use the Security Intelligence feature. Remove any populated global whitelist or blacklist from the policy’s Security Intelligence configuration.
 
      	 [bookmark: pgfId-1649573]Do  not include access control rules with Monitor or Interactive Block actions. Use only Allow, Trust, and Block rules. Keep in mind that allowed traffic can be inspected by discovery; trusted and blocked traffic cannot.
 
      	 [bookmark: pgfId-1649574]Do  not include access control rules with application, user, URL, or geolocation-based network conditions, even if your devices are appropriately licensed. Use only simple network-based conditions: zone, IP address, VLAN tag, and port.
 
      	 [bookmark: pgfId-1649575]Do  not include access control rules that perform file, malware, or intrusion inspection, even if your devices are appropriately licensed. In other words, do not associate a file policy or intrusion policy with any access control rule.
 
      	 [bookmark: pgfId-1649576]Make sure that the default intrusion policy for the access control policy is set to  No Rules Active ; see Setting the Default Intrusion Policy for Access Control.
 
      	 [bookmark: pgfId-1649580]Select  Network Discovery Only as the policy’s default action. Do  not choose a default action for the policy that performs intrusion inspection.
 
     
 
     [bookmark: pgfId-1649581]Note that with the exception of geolocation-based access control, the options described above require at least a Protection license. If you have only a FireSIGHT license, the system prevents you from applying an access control policy using these features.
 
     [bookmark: pgfId-1649588]After you configure and apply the access control policy, you can configure and apply the network discovery policy, which specifies the network segments, ports, and zones that the system examines for discovery data, as well as whether hosts, applications, and users are discovered on the segments, ports, and zones.
 
    
 
     
      [bookmark: pgfId-1649590][bookmark: 96359]Performing Intrusion Detection and Prevention without Discovery
 
     [bookmark: pgfId-1649597]License: Protection
 
     [bookmark: pgfId-1649598]The intrusion detection and prevention feature allows you to analyze network traffic for intrusions and exploits and, optionally, drop offending packets. If you want to perform intrusion inspection but do not need to take advantage of discovery data, you can improve a device’s performance by disabling discovery.
 
      
       
     
 
     
 
     [bookmark: pgfId-1649599]Note If you are performing application, user, or URL control, you cannot disable discovery for a performance benefit. Although you can prevent the system from storing it, the system must collect and examine discovery data to implement those features.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1649600]To disable discovery, implement all of the following guidelines; misconfiguring any eliminates the performance benefit:
 
      
      	 [bookmark: pgfId-1649601]In your access control policy, do  not include rules with application, user, URL, or geolocation-based network conditions, even if your devices are appropriately licensed. Use only simple network-based conditions: zone, IP address, VLAN tag, and port.
 
      	 [bookmark: pgfId-1649602]Delete all rules from your network discovery policy.
 
     
 
     [bookmark: pgfId-1649603]After you apply the access control policy and then the network discovery policy, new discovery halts on target devices. The system gradually deletes information in your network map according to the timeout periods you specified in the network discovery policy. Or, you can purge all discovery data immediately, see Purging Discovery Data from the Database.
 
    
 
   
 
    
     [bookmark: pgfId-1648677][bookmark: 53405]Troubleshooting Ac[bookmark: marker-1648675]cess Control Policies and Rules
 
    [bookmark: pgfId-1648681]License: Any
 
    [bookmark: pgfId-1649787]Properly configuring access control policies, especially creating and ordering access control rules, is a complex task. However, it is a task that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules or contain invalid configurations. Both rules and other policy settings can require additional licenses. 
 
    [bookmark: pgfId-1651586]To help ensure that the system handles traffic as you expect, the access control policy interface has a robust feedback system. Icons in the access control policy and rule editors mark warnings and errors, as described in the Access Control Error Icons table. Hover your pointer over an icon to read the warning, error, or informational text. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1651804]Tip In the access control policy editor, click Show Warnings to display a pop-up window that lists all the warnings for the policy.
 
     
     
 
    
 
    
 
     
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1648690]Table 12-7 [bookmark: 16039]Access Control Error Icons 
 
       
       
        
        	 
          
          [bookmark: pgfId-1648696]Icon 
         
  
        	 
          
          [bookmark: pgfId-1648698]Description 
         
  
        	 
          
          [bookmark: pgfId-1648700]Details 
         
  
       
 
       
          
        	[bookmark: pgfId-1648717]error
  
        	[bookmark: pgfId-1648719]If a rule or configuration has an error, you cannot apply the policy until you correct the issue, even if you disable any affected rules.
  
       
 
       
          
        	[bookmark: pgfId-1650749]warning
  
        	[bookmark: pgfId-1652678]You can apply an access control policy that displays rule or other warnings. However, misconfigurations marked with warnings have no effect. 
 [bookmark: pgfId-1652914]For example, you can apply a policy that contains preempted rules or rules that cannot match traffic due to misconfiguration—conditions using empty object groups, application filters that match no applications, configuring URL conditions without having enabled cloud communications, and so on. These rules do not evaluate traffic. If you disable a rule with a warning, the warning icon disappears. It reappears if you enable the rule without correcting the underlying issue.
 [bookmark: pgfId-1652682]As another example, many features require a specific license or device model. An access control policy successfully applies only to eligible target devices.
  
       
 
       
          
        	[bookmark: pgfId-1648726]information
  
        	[bookmark: pgfId-1648728]Information icons convey helpful information about configurations that may affect the flow of traffic. These issues do not prevent you from applying the policy.
 [bookmark: pgfId-1648729]For example, if you are performing application control or URL filtering, the system may skip matching the first few packets of a connection against some access control rules, until the system identifies the application or web traffic in that connection. This allows connections to be established so that applications and HTTP requests can be identified. For more information, see Limitations to Application Control and Limitations to URL Detection and Blocking.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1648737]Properly configuring access control policies and rules can also reduce the resources required to process network traffic. Creating complex rules, invoking many different intrusion policies, and mis-ordering rules can all affect performance.
 
    [bookmark: pgfId-1648738]For more information, see:
 
     
     	 [bookmark: pgfId-1648742]Access Control License and Role Requirements
 
     	 [bookmark: pgfId-1648746]Simplifying Rules to Improve Performance
 
     	 [bookmark: pgfId-1648750]Understanding Rule Preemption and Invalid Configuration Warnings
 
     	 [bookmark: pgfId-1648754]Ordering Rules to Improve Performance and Avoid Preemption
 
    
 
     
      [bookmark: pgfId-1648891][bookmark: 20624]Simplifying Rules to Improve Performance
 
     [bookmark: pgfId-1648892]Complex access control policies and rules can command significant resources. When you apply an access control policy, the system evaluates all the rules together and creates an expanded set of criteria that target devices use to evaluate network traffic. A pop-up window may warn that you have exceeded the maximum number of access control rules or intrusion policies supported by a target device. This maximum depends on a number of factors, including the physical memory and the number of processors on the device. 
 
     [bookmark: pgfId-1648893]Simplifying Access Control Rules
 
     [bookmark: pgfId-1648894]The following guidelines can help you simplify access control rules and improve performance:
 
      
      	 [bookmark: pgfId-1648895]When constructing a rule, use as few individual elements in your conditions as possible. For example, in network conditions, use IP address blocks rather than individual IP addresses. In port conditions, use port ranges. Use application filters and URL categories and reputations to perform application control and URL filtering, and LDAP user groups to perform user control.
 
     
 
     [bookmark: pgfId-1648896]Note that combining elements into objects that you then use in access control rule conditions does not improve performance. For example, using a network object that contains 50 individual IP addresses gives you only an organizational—not a performance—benefit over including those IP addresses in the condition individually.
 
      
      	 [bookmark: pgfId-1648897]Restrict rules by security zones whenever possible. If a device’s interfaces are not in one of the zones in a zone-restricted rule, the rule does not affect performance on that device.
 
      	 [bookmark: pgfId-1648898]Do not overconfigure rules. If one condition is enough to match the traffic you want to handle, do not use two.
 
     
 
     [bookmark: pgfId-1648899]Avoiding Intrusion Policy and Variable Set Proliferation
 
     [bookmark: pgfId-1648900]The number of unique intrusion policies you can use to inspect traffic in an access control policy depends on the resources on your device and the complexity of your policies: you can associate one intrusion policy with each Allow and Interactive Block rule, as well as with the default action. Every unique pair of intrusion policy and variable set counts as one policy. 
 
     [bookmark: pgfId-1664595]If you exceed the number of intrusion policies supported by your device, reevaluate your access control policy. You may want to consolidate intrusion policies or variable sets so you can associate a single intrusion policy-variable set pair with multiple access control rules.
 
     [bookmark: pgfId-1683710]Check to see how many policies you select and how many variable sets those policies use in each of the following locations in your access control policy: the Intrusion Policy used before Access Control rule is determined option in the Advanced access control policy settings, the default action for the access control policy, and the inspection settings for any access control rules in the policy.
 
    
 
     
      [bookmark: pgfId-1648903][bookmark: 91652]Understanding Rule Preemption and Invalid Configuration Warnings
 
     [bookmark: pgfId-1648907]License: Any
 
     [bookmark: pgfId-1648908]Properly configuring and ordering access control rules (and, in advanced deployments, network analysis rules) is essential to building an effective deployment. Within an access control policy, access control rules can preempt other rules or contain invalid configurations. Similarly, network analysis rules, which you configure using the access control policy’s advanced settings, can have the same issues. The system uses warning and error icons to mark these.
 
     [bookmark: pgfId-1648909]Understanding Rule Preemption Warnings
 
     [bookmark: pgfId-1648910]The conditions of an access control rule may preempt a subsequent rule from matching traffic. For example:
 
      
      [bookmark: pgfId-1648911]Rule 1: allow Admin users 
     
 
      
      [bookmark: pgfId-1648912]Rule 2: block Admin users 
     
 
     [bookmark: pgfId-1648913]The second rule above will never block traffic because the first rule will have already allowed the traffic.
 
     [bookmark: pgfId-1648914]Any type of rule condition can preempt a subsequent rule. For example, the VLAN range in the first rule below includes the VLAN in the second rule, so the first rule preempts the second rule:
 
      
      [bookmark: pgfId-1648915]Rule 1: allow VLAN 22-33 
     
 
      
      [bookmark: pgfId-1648916]Rule 2: block VLAN 27 
     
 
     [bookmark: pgfId-1648917]In the following example, Rule 1 matches any VLAN because no VLANs are configured, so Rule 1 preempts Rule 2, which attempts to match VLAN 2:
 
      
      [bookmark: pgfId-1648918]Rule 1: allow Source Network 10.4.0.0/16 
     
 
      
      [bookmark: pgfId-1648919]Rule 2: allow Source Network 10.4.0.0/16, VLAN 2 
     
 
     [bookmark: pgfId-1648920]A rule also preempts an identical subsequent rule where all configured conditions are the same. For example:
 
      
      [bookmark: pgfId-1648921]Rule 1: allow VLAN 1 URL www.example.com 
     
 
      
      [bookmark: pgfId-1648922]Rule 2: allow VLAN 1 URL www.example.com 
     
 
     [bookmark: pgfId-1648923]A subsequent rule would not be preempted if any condition is different. For example:
 
      
      [bookmark: pgfId-1648924]Rule 1: allow VLAN 1 URL www.example.com 
     
 
      
      [bookmark: pgfId-1648925]Rule 2: allow VLAN 2 URL www.example.com 
     
 
     [bookmark: pgfId-1648926]Understanding Invalid Configuration Warnings
 
     [bookmark: pgfId-1648927]Because outside settings that the access control policy depends on may change, an access control policy setting that was valid may become invalid. Consider the following examples:
 
      
      	 [bookmark: pgfId-1648930]A rule that performs URL filtering might be valid until you target a device that does not have a URL Filtering license. At that point, an error icon appears next to the rule, and you cannot apply the policy to that device until you edit or delete the rule, retarget the policy, or enable the appropriate license. 
 
      	 [bookmark: pgfId-1648932]If you add a port group to the source ports in a rule, then change the port group to include an ICMP port, the rule becomes invalid and a warning icon appears next to it. You can still apply the policy, but the rule will have no effect on network traffic.
 
      	 [bookmark: pgfId-1648933]If you add a user to a rule, then change your LDAP user awareness settings to exclude that user, the rule will have no effect because the user is no longer an access controlled user. 
 
     
 
    
 
     
      [bookmark: pgfId-1648935][bookmark: 54525]Ordering Rules to Improve Performance and Avoid Preemption
 
     [bookmark: pgfId-1648939]License: Any
 
     [bookmark: pgfId-1648940]Rules in an access control policy are numbered, starting at 1. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
     [bookmark: pgfId-1648941]Proper access control rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs.
 
     [bookmark: pgfId-1648942]Order Rules from Most to Least Critical
 
     [bookmark: pgfId-1648943]First, you must order rules to suit your organization's needs. Place priority rules that must apply to all traffic near the top of the policy. For example, if you want to inspect traffic from a single user for intrusions (using an Allow rule), but trust all other users in the department (using a Trust rule), place two access control rules in that order.
 
     [bookmark: pgfId-1648944]Order Rules from Specific to General
 
     [bookmark: pgfId-1648945]You can improve performance by placing specific rules earlier, that is, rules that narrowly define the traffic they handle. This is also important because rules with broad conditions can match many different types of traffic, and can preempt later, more specific rules.
 
     [bookmark: pgfId-1648946]Consider a scenario where you want to block most social networking sites, but allow access to certain others. For example, you may want your graphic designers to be able to access Creative Commons Flickr and deviantART content, but not access other sites such as Facebook or Google+. You should order your rules as follows:
 
      
      [bookmark: pgfId-1648947]Rule 1: Allow Flickr, deviantART for the “Design” LDAP user group 
     
 
      
      [bookmark: pgfId-1648948]Rule 2: Block social networking 
     
 
     [bookmark: pgfId-1648949]If you reverse the rules:
 
      
      [bookmark: pgfId-1648950]Rule 1: Block social networking 
     
 
      
      [bookmark: pgfId-1648951]Rule 2: Allow Flickr, deviantART for the “Design” LDAP user group 
     
 
     [bookmark: pgfId-1648952]the first rule blocks all social networking traffic, including Flickr and deviantART. Because no traffic will ever match the second rule, your designers cannot access the content you wanted to make available.
 
     [bookmark: pgfId-1648953]Place Rules that Inspect Traffic Later
 
     [bookmark: pgfId-1648954]Because discovery, intrusion, file, and malware inspection require processing resources, placing rules that do not inspect traffic (Trust, Block) before rules that do (Allow, Interactive Block) can improve performance. This is because Trust and Block rules can divert traffic that the system might otherwise have inspected. All other factors being equal, that is, given a set of rules where none is more critical and preemption is not an issue, consider placing them in the following order:
 
      
      	 [bookmark: pgfId-1648955]Monitor rules that log matching connections, but take no other action on traffic
 
      	 [bookmark: pgfId-1648956]Trust and Block rules that handle traffic without further inspection
 
      	 [bookmark: pgfId-1648957]Allow and Interactive Block rules that do not inspect traffic further
 
      	 [bookmark: pgfId-1648958]Allow and Interactive Block rules that optionally inspect traffic for malware, intrusions, or both
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1530930][bookmark: 94414]Generating a Report of Current Acce[bookmark: marker-1535054]ss Control Settings
 
    [bookmark: pgfId-1531144]License: Any
 
     
      
       
       [bookmark: pgfId-1535283]Table 12-8 [bookmark: 90226]Access Control Policy Report Sections 
 
       
       
        
        	 
          
          [bookmark: pgfId-1535287]Section 
         
  
        	 
          
          [bookmark: pgfId-1535289]Description 
         
  
       
 
        
        	[bookmark: pgfId-1535299]Policy Information
  
        	[bookmark: pgfId-1535301]Provides the name and description of the policy, the name of the user who last modified the policy, and the date and time the policy was last modified.
  
       
 
        
        	[bookmark: pgfId-1535303]Device Targets
  
        	[bookmark: pgfId-1535305]Lists the managed devices targeted by the policy.
  
       
 
        
        	[bookmark: pgfId-1535307]HTTP Block Response 
 [bookmark: pgfId-1535308]HTTP Interactive Block Response
  
        	[bookmark: pgfId-1535310]Provides details on the pages you display to users when you block a website using the policy.
  
       
 
        
        	[bookmark: pgfId-1535315]Security Intelligence
  
        	[bookmark: pgfId-1535317]Provides details on the policy’s Security Intelligence whitelist and blacklist.
  
       
 
        
        	[bookmark: pgfId-1535322]Default Action
  
        	[bookmark: pgfId-1535326]Lists the default action and associated variable set, if any.
  
       
 
        
        	[bookmark: pgfId-1535329]Rules
  
        	[bookmark: pgfId-1535331]Lists each access control rule in the policy, and provides details about its configuration.
  
       
 
        
        	[bookmark: pgfId-1535339]Advanced Settings
  
        	[bookmark: pgfId-1535341]Detailed information on the policy’s advanced settings, including: 
 
          
          	 [bookmark: pgfId-1539703]network analysis policies used to preprocess traffic for the access control policy, as well as global preprocessing options
 
          	 [bookmark: pgfId-1540878]adaptive profile settings for passive deployments
 
          	 [bookmark: pgfId-1539874]performance settings for detecting files, malware, and intrusions
 
          	 [bookmark: pgfId-1540957]other policy-wide settings
 
         
  
       
 
        
        	[bookmark: pgfId-1535343]Referenced Objects
  
        	[bookmark: pgfId-1535345]Provides details on the reusable objects referenced by the access control policy, including intrusion policy variable sets and objects used by the SSL policy.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1535142]You can also generate an access control comparison report that compares a policy with the currently applied policy or with another policy. For more information, see Comparing Access Control Policies.
 
    [bookmark: pgfId-1534995]To view an access control policy report:
 
    [bookmark: pgfId-1663369]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1663370]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1663371]The Access Control Policy page appears.
 ) next to the policy for which you want to generate a report. Remember to save any changes before you generate an access control policy report; only saved changes appear in the report. 
    
 
    [bookmark: pgfId-1535003]The system generates the report. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
    [bookmark: pgfId-1648418]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1648422][bookmark: 14479]Comparing Access Control Po[bookmark: marker-1648421]licies
 
    [bookmark: pgfId-1648426]License: Any
 
    [bookmark: pgfId-1534875]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between two access control policies. You can compare any two policies or the currently applied policy with another policy. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies.
 
    [bookmark: pgfId-1534711]There are two tools you can use to compare policies:
 
     
     	 [bookmark: pgfId-1534712]The comparison view displays only the differences between two policies in a side-by-side format. The name of each policy appears in the title bar on the left and right sides of the comparison view except when you select  Running Configuration , in which case a blank bar represents the currently active policy.
 
    
 
    [bookmark: pgfId-1534713]You can use this to view and navigate both policies on the web interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-1534714]The comparison report creates a record of only the differences between two policies in a format similar to the policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-1534715]You can use this to save, copy, print, and share your policy comparisons for further examination.
 
    [bookmark: pgfId-1534716]For more information on understanding and using the policy comparison tools, see:
 
     
     	 [bookmark: pgfId-1534720]Using the Access Control Policy Comparison View
 
     	 [bookmark: pgfId-1534724]Using the Access Control Policy Comparison Report
 
    
 
     
      [bookmark: pgfId-1534726][bookmark: 29486]Using the Access Control Policy Comparison View
 
     [bookmark: pgfId-1534727]License: Any
 
     [bookmark: pgfId-1534728]The comparison view displays both policies in a side-by-side format, with each policy identified by name in the title bar on the left and right sides of the comparison view. When comparing two policies other than the running configuration, the time of last modification and the last user to modify are displayed with the policy name.
 
     [bookmark: pgfId-1534729]Differences between the two policies are highlighted:
 
      
      	 [bookmark: pgfId-1534730]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-1534731]Green indicates that the highlighted setting appears in one policy but not the other.
 
     
 
     [bookmark: pgfId-1534732]You can perform any of the actions in the following table.
 
     [bookmark: pgfId-1534767]
 
      
       
        
        [bookmark: pgfId-1534739]Table 12-9 [bookmark: 91381]Access Control Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534743]To... 
          
  
         	 
           
           [bookmark: pgfId-1534745]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1534747]navigate individually through changes
  
         	[bookmark: pgfId-1534749]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-1534755]generate a new policy comparison view
  
         	[bookmark: pgfId-1534757]click New Comparison.
 [bookmark: pgfId-1534758]The Select Comparison window appears. See Using the Access Control Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-1534763]generate a policy comparison report
  
         	[bookmark: pgfId-1534765]click Comparison Report. 
 [bookmark: pgfId-1534766]The policy comparison report creates a PDF document that lists only the differences between the two policies.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1534770][bookmark: 14990]Using the Access Control Policy Comparison Report
 
     [bookmark: pgfId-1534771]License: Any
 
     [bookmark: pgfId-1534772]An access control policy comparison report is a record of all differences between two access control policies or a policy and the currently applied policy identified by the policy comparison view, presented in PDF format. You can use this report to further examine the differences between two policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-1534773]You can generate an access control policy comparison report from the comparison view for any policies to which you have access. Remember to save any changes before you generate a policy report; only saved changes appear in the report.
 
     [bookmark: pgfId-1534774]The format of the policy comparison report is the same as the policy report with one exception: the policy report contains all configurations in the policy, and the policy comparison report lists only those configurations that differ between the policies. An access control policy comparison report contains the sections described in Table 12-8. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1534778]Tip You can use a similar procedure to compare SSL, network analysis, intrusion, file, system, or health policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534779]To compare two access control policies:
 
     [bookmark: pgfId-1663361]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1663362]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1663363]The Access Control Policy page appears.
 
     [bookmark: pgfId-1534783]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-1534784]The Select Comparison window appears.
 
     [bookmark: pgfId-1534786]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-1534787]To compare two different policies, select  Other Policy .
 
      
 
     
 
     [bookmark: pgfId-1534788]The page refreshes and the Policy A and Policy B drop-down lists appear.
 
      
       
       	 [bookmark: pgfId-1534789]To compare another policy to the currently active policy, select  Running Configuration. 
 
      
 
     
 
     [bookmark: pgfId-1534790]The page refreshes and the Target/Running Configuration A and Policy B drop-down lists appear.
 
     [bookmark: pgfId-1534791]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-1534792]If you are comparing two different policies, select the policies you want to compare from the Policy A and Policy B drop-down lists.
 
       	 [bookmark: pgfId-1534793]If you are comparing the running configuration to another policy, select the second policy from the Policy B drop-down list.
 
      
 
     
 
     [bookmark: pgfId-1534794]Step 5 Click OK to display the policy comparison view.
 
     [bookmark: pgfId-1534795]The comparison view appears.
 
     [bookmark: pgfId-1534796]Step 6 Optionally, click Comparison Report to generate the access control policy comparison report.
 
     [bookmark: pgfId-1673829]The access control policy comparison report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
     [bookmark: pgfId-1673830]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1540523][bookmark: 13066]Blackl[bookmark: marker-1540522]isting Using Security Intelligence IP Address Reputation 
      
      
 
     
 
 
    [bookmark: pgfId-1534567]As a first line of defense against malicious Internet content, the FireSIGHT System includes the Security Intelligence feature, which allows you to immediately blacklist (block) connections based on the latest reputation intelligence, removing the need for a more resource-intensive, in-depth analysis. Security Intelligence filtering requires a Protection license and is supported on all managed devices with the exception of Series 2.
 
    [bookmark: pgfId-1534321]Security Intelligence works by blocking traffic to or from IP addresses that have a known bad reputation. This traffic filtering takes place before any other policy-based inspection, analysis, or traffic handling (although it does occur after hardware-level handling, such as fast-pathing).
 
    [bookmark: pgfId-1544201]Note that you could create access control rules that perform a similar function to Security Intelligence filtering by manually restricting traffic by IP address. However, access control rules are wider in scope, more complex to configure, and cannot automatically update using dynamic feeds.
 
    [bookmark: pgfId-1532909]Traffic blacklisted by Security Intelligence is immediately blocked and therefore is not subject to any further inspection—not for intrusions, exploits, malware, and so on, but also not for network discovery. Optionally, and recommended in passive deployments, you can use a “monitor-only” setting for Security Intelligence filtering. This allows the system to analyze connections that would have been blacklisted, but also logs the match to the blacklist and generates an end-of-connection security intelligence event.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1540722] 
     Caution For traffic handled by Series 3 devices, the system processes certain Trust rules before an access control policy’s Security Intelligence blacklist, which can allow blacklisted traffic to pass uninspected. For more information, see 
     Limitations to Trusting or Blocking Traffic with Series 3 Devices. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1532437]For your convenience, Cisco provides the Intelligence Feed (sometimes called the Sourcefire Intelligence Feed), which is comprised of several regularly updated collections of IP addresses determined by the VRT to have a poor reputation. The Intelligence Feed tracks open relays, known attackers, bogus IP addresses (bogon), and so on. You can also customize the feature to suit the unique needs of your organization, for example:
 
     
     	 [bookmark: pgfId-1532449] third-party feeds —you can supplement the Intelligence Feed with third-party reputation feeds, which the system can automatically update just as it does the Cisco feed
 
     	 [bookmark: pgfId-1532453] custom blacklists —the system allows you to manually blacklist specific IP addresses in many ways depending on your needs
 
     	 [bookmark: pgfId-1532454] enforcing blacklisting by security zone —to improve performance, you may want to target enforcement, for example, restricting spam blacklisting to a zone that handles email traffic
 
     	 [bookmark: pgfId-1532455] monitoring instead of blacklisting —especially useful in passive deployments and for testing feeds before you implement them; you can merely monitor the violating sessions instead of blocking them, generating end-of-connection events
 
     	 [bookmark: pgfId-1532456] whitelisting to eliminate false positives — when a blacklist is too broad in scope, or incorrectly blocks traffic that you want to allow (for example, to vital resources), you can override a blacklist with a custom whitelist 
 
    
 
    [bookmark: pgfId-1534415]For detailed information on configuring your access control policy to perform Security Intelligence filtering and viewing the event data that this filtering produces, see the following sections:
 
     
     	 [bookmark: pgfId-1531980]Choosing a Security Intelligence Strategy
 
     	 [bookmark: pgfId-1531772]Building the Security Intelligence Whitelist and Blacklist
 
     	 [bookmark: pgfId-1532098]Logging Security Intelligence (Blacklisting) Decisions
 
     	 [bookmark: pgfId-1542238]Working with Connection & Security Intelligence Data
 
    
 
   
 
    
     [bookmark: pgfId-1531871][bookmark: 30307]Choosing a Security Intelligence Strategy
 
    [bookmark: pgfId-1531875]License: Protection
 
    [bookmark: pgfId-1541029]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-1536923]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1533200]The easiest way to construct a blacklist is to use the Intelligence Feed, which tracks IP addresses known to be open relays, known attackers, bogus IP addresses (bogon), and so on. Because the Intelligence Feed is regularly updated, using it ensures that the system uses up-to-date information to filter your network traffic. Malicious IP addresses that represent security threats such as malware, spam, botnets, and phishing may appear and disappear faster than you can update and apply new policies. 
 
    [bookmark: pgfId-1533202]To aug[bookmark: marker-1533201]ment the Intelligence Feed, you can perform Security Intelligence filtering using custom or third-party IP address lists and feeds, where:
 
     
     	 [bookmark: pgfId-1533206]a  list is a static list of IP addresses that you upload to the Defense Center
 
     	 [bookmark: pgfId-1533210]a  feed is a dynamic list of IP addresses that the Defense Center downloads from the Internet on a regular basis; the Intelligence Feed is a special kind of feed
 
    
 
    [bookmark: pgfId-1533214]For detailed information on configuring Security Intelligence lists and feeds, including high availability and Internet access requirements, see Working with Security Intelligence Lists and Feeds.
 
    [bookmark: pgfId-1532358]Using the Security Intelligence Global Blacklist
 
    [bookmark: pgfId-1533233]In the course of your analysis, you can build a global blacklist by selecting any IP address in an event view, the Context Explorer, or a dashboard. For example, if you notice a set of routable IP addresses in intrusion events associated with exploit attempts, you can immediately blacklist those IP addresses. The Defense Center uses this global blacklist (and a related global whitelist) to perform Security Intelligence filtering in all access control policies. For information on managing these global lists, see Working with the Global Whitelist and Blacklist.
 
     
      
    
 
    
 
    [bookmark: pgfId-1534125]Note Although feed updates and additions to the global blacklist (or global whitelist; see below) automatically implement changes throughout your deployment, any other change to a Security Intelligence object requires you to reapply the access control policy. For more information, see Table 3-1.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531915]Using Network Objects
 
    [bookmark: pgfId-1534759]Finally, a simple way to construct a blacklist is to use network objects or network object groups that represent an IP address, IP address block, or collection of IP addresses. For information on creating and modifying network objects, see Working with Network Objects.
 
    [bookmark: pgfId-1531933]Using Security Int[bookmark: marker-1531932]elligence Whitelists
 
    [bookmark: pgfId-1531934]In addition to a blacklist, each access control policy has an associated whitelist, which you can also populate with Security Intelligence objects. A policy’s whitelist overrides its blacklist. That is, the system evaluates traffic with a whitelisted source or destination IP address using access control rules, even if the IP address is also blacklisted. In general, use the whitelist if a blacklist is still useful, but is too broad in scope and incorrectly blocks traffic that you want to inspect.
 
    [bookmark: pgfId-1531935]For example, if a reputable feed improperly blocks your access to vital resources but is overall useful to your organization, you can whitelist only the improperly classified IP addresses, rather than removing the whole feed from the blacklist.
 
    [bookmark: pgfId-1531937]Enforcing Security Intelli[bookmark: marker-1531936]gence Filtering by Security Zone
 
    [bookmark: pgfId-1531938]For added granularity, you can enforce Security Intelligence filtering based on whether the source or destination IP address in a connection resides in a particular security zone.
 
    [bookmark: pgfId-1531939]To extend the whitelist example above, you could whitelist the improperly classified IP addresses, but then restrict the whitelist object using a security zone used by those in your organization who need to access those IP addresses. That way, only those with a business need can access the whitelisted IP addresses. As another example, you could use a third-party spam feed to blacklist traffic on an email server security zone.
 
    [bookmark: pgfId-1531940][bookmark: 22650]Monitoring—Rather than Blacklisting—Connections
 
    [bookmark: pgfId-1531941]If you are not sure whether you want to blacklist a particular IP address or set of addresses, you can use a “monitor-only” setting, which allows the system to pass the matching connection to access control rules, but also logs the match to the blacklist and generates an end-of-connection Security Intelligence event. Note that you cannot set the global blacklist to monitor-only. For more information, see 
 
    [bookmark: pgfId-1531942]Consider a scenario where you want to test a third-party feed before you implement blocking using that feed. When you set the feed to monitor-only, the system allows connections that would have been blocked to be further analyzed by the system, but also logs a record of each of those connections for your evaluation.
 
    [bookmark: pgfId-1531946]In passive deployments, to optimize performance, Cisco recommends that you always use monitor-only settings. Managed devices that are deployed passively cannot affect traffic flow; there is no advantage to configuring the system to block traffic. Additionally, because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection.
 
   
 
    
     [bookmark: pgfId-1530994][bookmark: 88286]Building the Security Intelligence White[bookmark: marker-1530993]list and Blacklist
 
    [bookmark: pgfId-1536592]License: Protection
 
    [bookmark: pgfId-1541003]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-1536897]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1531010]To build a whitelist and blacklist, you populate them with any combination of network objects and groups, as well as Security Intelligence feeds and lists, all of which you can constrain by security zone.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1543902] 
     Caution Changing a Security Intelligence list, except via the 
     Whitelist Now or 
     Blacklist Now options from the right-click menu, restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1531014]By default, access control policies use the Defense Center’s global whitelist and blacklist, which apply to any zone. These lists are populated by your analysts, who can quickly add individual IP addresses using the context menu. You can opt not to use these global lists on a per-policy basis.
 
     
      
    
 
    
 
    [bookmark: pgfId-1533500]Note You cannot apply an access control policy that uses a populated global whitelist or blacklist to Series 2 devices (or to other devices not licensed for Protection). If you added IP addresses to either global list, you must remove the non-empty list from the policy’s Security Intelligence configuration before you can apply the policy. For more information, see Working with the Global Whitelist and Blacklist.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531018]After you build your whitelist and blacklist, you can log blacklisted connections. You can also set individual blacklisted objects, including feeds and lists, to monitor-only. This allows the system to handle connections involving blacklisted IP addresses using access control, but also logs the connection’s match to the blacklist.
 ) represent the different categories in the Intelligence Feed. 
    
 
    [bookmark: pgfId-1543447]Active scanners and blacklisted hosts known for outbound malicious activity
 
    [bookmark: pgfId-1543449]Malware
 
    [bookmark: pgfId-1543451]Sites that host malware binaries or exploit kits
 
    [bookmark: pgfId-1543586]Phishing
 
    [bookmark: pgfId-1543588]Sites that host phishing pages
 
    [bookmark: pgfId-1543582]Spam
 
    [bookmark: pgfId-1543584]Mail hosts that are known for sending spam
 
    [bookmark: pgfId-1543578]Bots
 
    [bookmark: pgfId-1543580]Sites that host binary malware droppers
 
    [bookmark: pgfId-1543574]CnC
 
    [bookmark: pgfId-1543576]Sites that host command and control servers for botnets
 
    [bookmark: pgfId-1543570]OpenProxy
 
    [bookmark: pgfId-1543572]Open proxies that allow anonymous web browsing
 
    [bookmark: pgfId-1543566]OpenRelay
 
    [bookmark: pgfId-1543568]Open mail relays that are known to be used for spam
 
    [bookmark: pgfId-1543562]TorExitNode
 
    [bookmark: pgfId-1543564]Tor exit nodes 
 
    [bookmark: pgfId-1543558]Bogon
 
    [bookmark: pgfId-1543560] Bogon networks and unallocated IP addresses
 
   
 ). Because the whitelist overrides the blacklist, if you add the same object to both lists, the system displays the blacklisted object with a strikethrough. 
   
 
   [bookmark: pgfId-1531036]You can add up to a total of 255 objects to the whitelist and the blacklist. That is, the number of objects in the whitelist plus the number in the blacklist cannot exceed 255.
 
   [bookmark: pgfId-1531037]Note that although you can add network objects with a netmask of /0 to the whitelist or blacklist, address blocks using a /0 netmask in those objects will be ignored and whitelist and blacklist filtering will not occur based on those addresses. Address blocks with a /0 netmask from Security Intelligence feeds are also ignored. If you want to monitor or block all traffic targeted by a policy, use an access control rule with the Monitor or Block rule action, respectively, and a default value of any for the Source Networks and Destination Networks, instead of Security Intelligence filtering.
 
   [bookmark: pgfId-1531042]To build the Security Intelligence whitelist and blacklist for an access control policy:
 
   [bookmark: pgfId-1531043]Access: Admin/Access Admin/Network Admin
 
   
 
   [bookmark: pgfId-1539465]Step 1 Select Policies > Access Control.
 
   [bookmark: pgfId-1539466]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
   
 
   [bookmark: pgfId-1531050]The access control policy editor appears.
 
   [bookmark: pgfId-1531051]Step 3 Select the Security Intelligence tab.
 
   [bookmark: pgfId-1531052]Security Intelligence settings for the access control policy appear.
 ) to log blacklisted connections. 
   
 
   [bookmark: pgfId-1531057]You must enable logging before you can set blacklisted objects to monitor-only. For details, see Logging Security Intelligence (Blacklisting) Decisions.
 
   [bookmark: pgfId-1531062]Step 5 [bookmark: 14249]Begin building your whitelist and blacklist by selecting one or more Available Objects.
 
   [bookmark: pgfId-1531063]Use Shift and Ctrl to select multiple objects, or right-click and Select All.
 
    
     
   
 
   
 
   [bookmark: pgfId-1531064]Tip You can search for existing objects to include, or create objects on the fly if no existing objects meet the needs of your organization. For more information, see Searching for Objects to Whitelist or Blacklist and Creating Objects to Whitelist or Blacklist.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-1531071]Step 6 Optionally, constrain the selected objects by zone by selecting an Available Zone.
 
   [bookmark: pgfId-1531072]By default, objects are not constrained, that is, they have a zone of Any. Note that other than using Any, you can constrain by only one zone. To enforce Security Intelligence filtering for an object on multiple zones, you must add the object to the whitelist or blacklist separately for each zone. Also, the global whitelist or blacklist cannot be constrained by zone.
 
   [bookmark: pgfId-1531074]Step 7 [bookmark: 56449]Click Add to Whitelist or Add to Blacklist.
 
   [bookmark: pgfId-1531075]You can also click and drag the selected objects to either list.
 
   [bookmark: pgfId-1538636]The objects you selected are added to the whitelist or blacklist.
 
    
     
   
 
   
 
   
 
   [bookmark: pgfId-1531089]Step 8 Repeat steps 5 through 7 until you are finished adding objects to your whitelist and blacklist.
 
   [bookmark: pgfId-1531090]Step 9 Optionally, set blacklisted objects to monitor-only by right-clicking the object under Blacklist, then selecting Monitor-only (do not block).
 
   [bookmark: pgfId-1531094]In passive deployments, Cisco recommends you set all blacklisted objects to monitor-only. Note, however, that you cannot set the global blacklist to monitor-only. 
 
   [bookmark: pgfId-1531095]Step 10 Click Save.
 
   [bookmark: pgfId-1531096]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
   [bookmark: pgfId-1536393]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1531101][bookmark: 88257]Searching for Objects to Whitelist or Blacklist
 
    [bookmark: pgfId-1536618]License: Protection
 
    [bookmark: pgfId-1540985]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-1536879]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1531117]If you have multiple network objects, groups, feeds, and lists, use the search feature to narrow the objects you want to blacklist or whitelist.
 
    [bookmark: pgfId-1531118]To search for objects to whitelist or blacklist:
 
    [bookmark: pgfId-1531119]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1531120]Step 1 Type your query in the Search by name or value field.
 ) in the search field. 
    
 
    [bookmark: pgfId-1531128]You can search on network object names and on the values configured for those objects. For example, if you have an individual network object named Texas Office with the configured value 192.168.3.0/24, and the object is included in the group object US Offices, you can display both objects by typing a partial or complete search string such as Tex, or by typing a value such as 3.
 
    [bookmark: pgfId-1536404]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1531131][bookmark: 51268]Creating Objects to [bookmark: marker-1531130]Whitelist or Blacklist
 
    [bookmark: pgfId-1536636]License: Protection
 
    [bookmark: pgfId-1536812]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-1536861]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1531147]While editing an access control policy, you can create an object on-the-fly to use in its whitelist and blacklist: either a network object or a Security Intelligence list or feed. Note that to group network objects or create network object groups, you must use the object manager.
 
    [bookmark: pgfId-1531148]To create objects to whitelist or blacklist:
 
    [bookmark: pgfId-1531149]Access: Admin/Access Admin/Network Admin
 
    
 ), then select the type of object you want to create: 
    
 
     
      
      	 [bookmark: pgfId-1531154]Select  Add IP List to create a Security Intelligence list or feed; see Working with Security Intelligence Lists and Feeds.
 
      	 [bookmark: pgfId-1531160]Select  Add Network Object to add a network object; see Working with Network Objects.
 
     
 
    
 
    [bookmark: pgfId-1536457]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1623889][bookmark: 24637]Tuning Traffic Flow Using Access Control Rules 
      
      
 
     
 
 
    [bookmark: pgfId-1678168]Within an access control policy, access control rules provide a granular method of handling network traffic across multiple managed devices.
 
     
      
    
 
    
 
    [bookmark: pgfId-1678169]Note Hardware-based fast-path rules, Security Intelligence-based traffic filtering, and some decoding and preprocessing occur before network traffic is evaluated by access control rules. You can also configure the SSL inspection feature to block or decrypt encrypted traffic before access control rules evaluate it.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1623895]The system matches traffic to access control rules in the order you specify. In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. Conditions can be simple or complex; you can control traffic by security zone, network or geographical location, VLAN, port, application, requested URL, and user.
 
    [bookmark: pgfId-1623896]Each rule also has an action, which determines whether you monitor, trust, block, or allow matching traffic. When you allow traffic, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network. However, after the system trusts or blocks traffic, it does not perform further inspection.
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1681847]In this scenario, traffic is evaluated as follows:
 
     
     	 [bookmark: pgfId-1677713] Rule 1: Monitor evaluates traffic first. Monitor rules track and log network traffic but do not affect traffic flow. The system continues to match traffic against additional rules to determine whether to permit or deny it.
 
     	 [bookmark: pgfId-1623904] Rule 2: Trust evaluates traffic next. Matching traffic is allowed to pass to its destination without further inspection. Traffic that does not match continues to the next rule.
 
     	 [bookmark: pgfId-1623905] Rule 3: Block evaluates traffic third. Matching traffic is blocked without further inspection. Traffic that does not match continues to the final rule.
 
     	 [bookmark: pgfId-1623906] Rule 4: Allow is the final rule. For this rule, matching traffic is allowed; however, prohibited files, malware, intrusions, and exploits within that traffic are detected and blocked. Remaining non-prohibited, non-malicious traffic is allowed to its destination. Note that you might have additional Allow rules that perform only file inspection, or only intrusion inspection, or neither.
 
     	 [bookmark: pgfId-1674315] Default Action handles all traffic that does not match any of the rules. In this scenario, the default action performs intrusion prevention before allowing non-malicious traffic to pass. In a different deployment, you might have a default action that trusts or blocks all traffic, without further inspection. (You cannot perform file or malware inspection on traffic handled by the default action.)
 
    
 
    [bookmark: pgfId-1680436]Traffic you allow, whether with an access control rule or the default action, is automatically eligible for inspection for host, application, and user data by the network discovery policy. You do not explicitly enable discovery, although you can enhance or disable it. However, allowing traffic does not automatically guarantee discovery data collection. The system performs discovery only for connections involving IP addresses that are explicitly monitored by your network discovery policy; additionally, application discovery is limited for encrypted sessions. For more information, see Introduction to Network Discovery.
 
    [bookmark: pgfId-1680443]Note that access control rules handle encrypted traffic when your SSL inspection configuration allows it to pass, or if you do not configure SSL inspection. However, some access control rule conditions require unencrypted traffic, so encrypted traffic may match fewer rules. Also, by default, the system disables intrusion and file inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured. For more information, see Understanding Traffic Decryption and Using the SSL Preprocessor.
 
    [bookmark: pgfId-1625784]For more information on access control rules, see:
 
     
     	 [bookmark: pgfId-1623916]Creating and Editing Access Control Rules
 
     	 [bookmark: pgfId-1623920]Managing Access Control Rules in a Policy
 
     	 [bookmark: pgfId-1623924]Troubleshooting Access Control Policies and Rules
 
    
 
   
 
    
     [bookmark: pgfId-1623926][bookmark: 42436]Creating and Editing Access Control Rules
 
    [bookmark: pgfId-1623930]License: Any
 
    [bookmark: pgfId-1639344]Within an access control policy, access control rules provide a granular method of handling network traffic across multiple managed devices. In addition to its unique name, each access control rule has the following basic components: 
 
    [bookmark: pgfId-1623932]State
 
    [bookmark: pgfId-1623933]By default, rules are enabled. If you disable a rule, the system does not use it to evaluate network traffic, and stops generating warnings and errors for that rule.
 
    [bookmark: pgfId-1623934]Position
 
    [bookmark: pgfId-1623935]Rules in an access control policy are numbered, starting at 1. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
    [bookmark: pgfId-1623936]Conditions
 
    [bookmark: pgfId-1623937]Conditions specify the specific traffic the rule handles. Conditions can match traffic by security zone, network or geographical location, VLAN, port, application, requested URL, or user. Conditions can be simple or complex; their use often depends on target device license and model.
 
    [bookmark: pgfId-1623938]Action
 
    [bookmark: pgfId-1623939]A rule’s action determines how the system handles matching traffic. You can monitor, trust, block, or allow (with or without further inspection) matching traffic. Note that the system does not perform inspection on trusted or blocked traffic.
 
    [bookmark: pgfId-1623940]Inspection
 
    [bookmark: pgfId-1623941]Inspection options for an access control rule govern how the system inspects and blocks malicious traffic you would otherwise allow. When you allow traffic with a rule, you can specify that the system first inspect it with intrusion or file policies to block any exploits, malware, or prohibited files before they reach your assets or exit your network.
 
    [bookmark: pgfId-1623942]Logging
 
    [bookmark: pgfId-1623943]A rule’s logging settings govern the records the system keeps of the traffic it handles. You can keep a record of traffic that matches a rule. In general, you can log sessions at the beginning or end of a connection, or both. You can log connections to the Defense Center database, as well as to the system log (syslog) or to an SNMP trap server.
 
    [bookmark: pgfId-1623947]Comments
 
    [bookmark: pgfId-1623948]Each time you save changes to an access control rule, you can add a comment.
 
    [bookmark: pgfId-1623949]Use the access control rule editor to add and edit access control rules; access the rule editor from the Rules tab of the access control policy editor. In the rule editor, you:
 
     
     	 [bookmark: pgfId-1623950]Configure basic properties such as the rule’s name, state, position, and action in the upper portion of the editor.
 
     	 [bookmark: pgfId-1623951]Add conditions using the tabs on the left side of the lower portion of the editor. 
 
     	 [bookmark: pgfId-1623952]Use the tabs on the right side of the lower portion to configure inspection and logging options, and also to add comments to the rule. For your convenience, the editor lists the rule’s inspection and logging options regardless of which tab you are viewing.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1623953]Note Properly creating and ordering access control rules is a complex task, but one that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules, require additional licenses, or contain invalid configurations. To help ensure that the system handles traffic as you expect, the access control policy interface has a robust warning and error feedback system for rules. For more information, see Troubleshooting Access Control Policies and Rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1623957]To create or modify an access control rule:
 
    [bookmark: pgfId-1623961]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1623962]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1623963]The Access Control Policy page appears.
 ) next to the access control policy where you want to add a rule. 
    
 
    [bookmark: pgfId-1623968]The policy page appears, focused on the Rules tab.
 
    [bookmark: pgfId-1623969]Step 3 You have the following options:
 
     
      
      	 [bookmark: pgfId-1623970]To add a new rule, click  Add Rule .
 
      	 [bookmark: pgfId-1623974]To edit an existing rule, click the edit icon (
 
     
 
     [image: ] ) next to the rule you want to edit. 
    
 
    [bookmark: pgfId-1623975]The access control rule editor appears.
 
    [bookmark: pgfId-1623976]Step 4 Type a Name for the rule.
 
    [bookmark: pgfId-1623977]Each rule must have a unique name. You can use up to thirty printable characters, including spaces and special characters, with the exception of the colon (:).
 
    [bookmark: pgfId-1623978]Step 5 Configure the rule components, as summarized above. You can configure the following, or accept the defaults:
 
     
      
      	 [bookmark: pgfId-1623979]Specify whether the rule is  Enabled .
 
      	 [bookmark: pgfId-1623983]Specify the rule position; see Specifying a Rule's Order of Evaluation.
 
      	 [bookmark: pgfId-1623986]Select a rule  Action ; see Using Rule Actions to Determine Traffic Handling and Inspection.
 
      	 [bookmark: pgfId-1623990]Configure the rule’s conditions; see Using Conditions to Specify the Traffic a Rule Handles.
 
      	 [bookmark: pgfId-1623994]For Allow and Interactive Block rules, configure the rule’s  Inspection options; see Controlling Traffic Using Intrusion and File Policies. 
 
      	 [bookmark: pgfId-1623998]Specify  Logging options; see Logging Connections in Network Traffic.
 
      	 [bookmark: pgfId-1624003]Add  Comments ; see Adding Comments to a Rule.
 
     
 
    
 
    [bookmark: pgfId-1624004]Step 6 Click Save to save the rule.
 ) to delete the rule. You must apply the access control policy for your changes to take effect; see 
    Applying an Access Control Policy. 
    
 
    [bookmark: pgfId-1624012]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1624014][bookmark: 66701]Specifying a Rule's Order of Evaluation
 
     [bookmark: pgfId-1624018]License: Any
 
     [bookmark: pgfId-1624019]When you first create an access control rule, you specify its position using the Insert drop-down list in the rule editor. Rules in an access control policy are numbered, starting at 1. The system matches traffic to access control rules in top-down order by ascending rule number. 
 
     [bookmark: pgfId-1624020]In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. Except in the case of Monitor rules (which log traffic but do not affect traffic flow), the system does not continue to evaluate traffic against additional, lower-priority rules after that traffic matches a rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-1624021]Tip Proper access control rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs. For more information, see Ordering Rules to Improve Performance and Avoid Preemption.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1624025]In addition to ordering rules by number, you can group rules by category. By default the system provides three categories: Administrator, Standard, and Root. You can add custom categories, but you cannot delete the Cisco-provided categories or change their order. For information on changing the position or category of an existing rule, see Changing a Rule's Position or Category.
 
     [bookmark: pgfId-1624032]To add a rule to a category while editing or creating a rule:
 
     [bookmark: pgfId-1624036]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1624037]Step 1 In the access control rule editor, from the Insert drop-down list, select Into Category, then select the category you want to use.
 
     [bookmark: pgfId-1624038]When you save the rule, it is placed last in that category.
 
     [bookmark: pgfId-1624039]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1624040]To position a rule by number while editing or creating a rule:
 
     [bookmark: pgfId-1624044]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1624045]Step 1 In the access control rule editor, from the Insert drop-down list, select above rule or below rule, then type the appropriate rule number.
 
     [bookmark: pgfId-1624046]When you save the rule, it is placed where you specified.
 
     [bookmark: pgfId-1624047]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624049][bookmark: 31965]Using Conditions to Specify the Traffic a Rule Handles
 
     [bookmark: pgfId-1624053]License: feature dependent
 
     [bookmark: pgfId-1624057]Supported Devices: feature dependent
 
     [bookmark: pgfId-1624061]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1663901]An access control rule’s conditions identify the type of traffic that rule handles. Conditions can be simple or complex; you can control traffic by security zone, network or geographical location, VLAN, port, application, requested URL, and user. 
 
     [bookmark: pgfId-1663902]When adding conditions to access control rules, keep the following points in mind:
 
      
      	 [bookmark: pgfId-1660750]You can configure multiple conditions per rule. Traffic must match  all the conditions in the rule for the rule to apply to traffic. For example, you can use a single rule to perform URL filtering (URL condition) for specific hosts (zone or network condition).
 
      	 [bookmark: pgfId-1661728]For each condition in a rule, you can add up to 50 criteria. Traffic that matches  any of a condition’s criteria satisfies the condition. For example, you can use a single rule to perform user control for up to 50 users and groups.
 
     
 
     [bookmark: pgfId-1683084]Note that you can constrain zone and network conditions by source and destination, using up to 50 source and up to 50 destination criteria. If you add both source and destination criteria to a zone or network condition, matching traffic must originate from one of the specified source zones/networks and egress through one of the destination zones/networks. In other words, the system links multiple condition criteria of the same type with an OR operation, and links multiple condition types with an AND operation. For example, if your rule conditions are:
 
      
      [bookmark: pgfId-1660343]Source Networks: 10.0.0.0/8, 192.168.0.0/16 
     
 
      
      [bookmark: pgfId-1665010]Application Category: peer to peer 
     
 
     [bookmark: pgfId-1660344]the rule would match peer-to-peer application traffic from a host on one of your private IPv4 networks—a packet must originate from either one OR the other source network, AND represent peer-to-peer application traffic. Both of the following connections trigger the rule: 
 
      
      [bookmark: pgfId-1663533]10.42.0.105 to anywhere, using LimeWire 
     
 
      
      [bookmark: pgfId-1663535]192.168.42.105 to anywhere, using Kazaa 
     
 
     [bookmark: pgfId-1662488]If you do not configure a particular condition for a rule, the system does not match traffic based on that criterion. For example, a rule with a network condition but no application condition evaluates traffic based on its source or destination, regardless of the application used in the session.
 
      
       
     
 
     
 
     [bookmark: pgfId-1662851]Note When you apply an access control policy, the system evaluates all its rules and creates an expanded set of criteria that target devices use to evaluate network traffic. Complex access control policies and rules can command significant resources. For tips on simplifying access control rules and other ways to improve performance, see Troubleshooting Access Control Policies and Rules.
 
      
      
 
     
 
     
 
      
      [bookmark: pgfId-1664126]These Conditions... 
     
 
      
      [bookmark: pgfId-1664128]Match Traffic... 
     
 
      
      [bookmark: pgfId-1664130]Details 
     
 
     [bookmark: pgfId-1664132]Zones
 
     [bookmark: pgfId-1664134]entering or leaving a device via an interface in a specific security zone
 
     [bookmark: pgfId-1664136]A security zone is a logical grouping of one or more interfaces according to your deployment and security policies. Interfaces in a zone may be located across multiple devices. To build a zone condition, see Controlling Traffic by Security Zone.
 
     [bookmark: pgfId-1664141]Networks
 
     [bookmark: pgfId-1664143]by its source or destination IP address, country, or continent
 
     [bookmark: pgfId-1664145]You can explicitly specify IP addresses or address blocks. The geolocation feature also allows you to control traffic based on its source or destination country or continent. To build a network condition, see Controlling Traffic by Network or Geographical Location.
 
     [bookmark: pgfId-1664150]VLAN Tags
 
     [bookmark: pgfId-1664152]tagged by VLAN
 
     [bookmark: pgfId-1664154]The system uses the innermost VLAN tag to identify a packet by VLAN. To build a VLAN condition, see Controlling VLAN Traffic.
 
     [bookmark: pgfId-1664159]Ports
 
     [bookmark: pgfId-1664161]by its source or destination port
 
     [bookmark: pgfId-1664163]For TCP and UDP, you can control traffic based on the transport layer protocol. For ICMP and ICMPv6 (IPv6-ICMP), you can control traffic based on its Internet layer protocol plus an optional type and code. Using port conditions, you can also control traffic using other protocols that do not use ports. To build a port condition, see Controlling Traffic by Port and ICMP Codes.
 
     [bookmark: pgfId-1664168]Applications
 
     [bookmark: pgfId-1664170]by the application detected in a session
 
     [bookmark: pgfId-1664172]You can control access to individual applications, or filter access according to basic characteristics: type, risk, business relevance, categories, and tags. To build an application condition, see Controlling Application Traffic.
 
     [bookmark: pgfId-1664177]URLs
 
     [bookmark: pgfId-1664179]by the URL requested in the session
 
     [bookmark: pgfId-1664181]You can limit the websites that users on your network can access either individually or based on the URL’s general classification and risk level. To build a URL condition, see Blocking URLs.
 
     [bookmark: pgfId-1664186]Users
 
     [bookmark: pgfId-1664188]by the user involved in the session
 
     [bookmark: pgfId-1664190]You can control traffic based on the LDAP user logged into a host involved in a monitored session. You can control traffic based on individual users or groups retrieved from a Microsoft Active Directory server. To build a user condition, see Controlling Traffic Based on Users.
 
    
 
    [bookmark: pgfId-1664195]Note that although you can create access control rules with any license, certain rule conditions require that you enable specific licensed capabilities on the access control policy’s targeted devices before you can apply the policy. For more information, see License and Model Requirements for Access Control.
 
   
 
    
     [bookmark: pgfId-1624151][bookmark: 71854]Using Rule Actions to Determine Traffic Handling and Inspection
 
    [bookmark: pgfId-1624155]License: Any
 
    [bookmark: pgfId-1624156]Every access control rule has an action that determines the following for matching traffic:
 
     
     	 [bookmark: pgfId-1624157]handling—foremost, the rule action governs whether the system will monitor, trust, block, or allow traffic that matches the rule’s conditions
 
     	 [bookmark: pgfId-1624158]inspection—certain rule actions allow you, when properly licensed, to further inspect matching traffic before allowing it to pass
 
     	 [bookmark: pgfId-1624159]logging—the rule action determines when and how you can log details about matching traffic
 
    
 
    [bookmark: pgfId-1624160]The access control policy’s default action handles traffic that does not meet the conditions of any non-Monitor access control rule; see Setting Default Handling and Inspection for Network Traffic. 
 
    [bookmark: pgfId-1624164]Keep in mind that only devices deployed inline can block or modify traffic. Devices deployed passively or in tap mode can analyze and log, but not affect, the flow of traffic. For detailed information on rule actions and how they affect traffic handling, inspection, and logging, see the following sections:
 
     
     	 [bookmark: pgfId-1624168]Monitor Action: Postponing Action and Ensuring Logging
 
     	 [bookmark: pgfId-1624172]Trust Action: Passing Traffic Without Inspection
 
     	 [bookmark: pgfId-1624176]Blocking Actions: Blocking Traffic Without Inspection
 
     	 [bookmark: pgfId-1624180]Interactive Blocking Actions: Allowing Users to Bypass Website Blocks
 
     	 [bookmark: pgfId-1624184]Allow Action: Allowing and Inspecting Traffic
 
     	 [bookmark: pgfId-1653771]Limitations to Trusting or Blocking Traffic with Series 3 Devices
 
     	 [bookmark: pgfId-1624188]Controlling Traffic Using Intrusion and File Policies
 
     	 [bookmark: pgfId-1624192]Logging Connections Based on Access Control Handling
 
    
 
   
 
    
     [bookmark: pgfId-1624194][bookmark: 75026]Monitor Action: Postponing Action and Ensuring Logging
 
    [bookmark: pgfId-1624198]License: Any
 
    [bookmark: pgfId-1624199]The Monitor action does not affect traffic flow; matching traffic is neither immediately permitted nor denied. Rather, traffic is matched against additional rules to determine whether to permit or deny it. The first non-Monitor rule matched determines traffic flow and any further inspection. If there are no additional matching rules, the system uses the default action.
 
    [bookmark: pgfId-1624200]Because the primary purpose of Monitor rules is to track network traffic, the system automatically logs end-of connection events for monitored traffic. That is, connections are logged even if the traffic matches no other rules and you do not enable logging on the default action. For more information, see Understanding Logging for Monitored Connections.
 
     
      
    
 
    
 
    [bookmark: pgfId-1624204]Note If locally-bound traffic matches a Monitor rule in a Layer 3 deployment, that traffic may bypass inspection. To ensure inspection of the traffic, enable Inspect Local Router Traffic in the advanced device settings for the managed device routing the traffic. For more information, see Understanding Advanced Device Settings.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1624206][bookmark: 47986]Trust Action: Passing Traffic Without Inspection
 
    [bookmark: pgfId-1624210]License: Any
 
    [bookmark: pgfId-1624211]The Trust action allows traffic to pass without further inspection of any kind.
 
    [bookmark: pgfId-1694995]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1653622]You can log trusted network traffic at both the beginning and end of connections. Note that the system logs TCP connections handled by a Trust rule differently depending on the model of the device that detected the connection. For more information, see Understanding Logging for Trusted Connections.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1653661] 
     Caution For traffic handled by Series 3 devices, the system processes certain Trust rules before an access control policy’s Security Intelligence blacklist, which can allow blacklisted traffic to pass uninspected. For more information, see 
     Limitations to Trusting or Blocking Traffic with Series 3 Devices. 
      
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1653634][bookmark: 80114]Blocking Actions: Blocking Traffic Without Inspection
 
    [bookmark: pgfId-1653638]License: Any
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1631120]For unencrypted HTTP traffic, when the system blocks a web request, you can override the default browser or server page with a custom page that explains that the connection was denied. The system calls this custom page an HTTP response page; see Displaying a Custom Web Page for Blocked URLs.
 
    [bookmark: pgfId-1653820]For decrypted and encrypted (HTTPS) traffic, Interactive Block rules block matching connections without interaction and the system does not display a response page. 
 
    [bookmark: pgfId-1683513]Note that the system does not display the configured response page for some successfully blocked traffic handled by Series 3 devices. Instead, users requesting prohibited URLs have their connection either reset or time out. For more information, see Limitations to Trusting or Blocking Traffic with Series 3 Devices.
 
    [bookmark: pgfId-1630072]You can log blocked network traffic only at the beginning of connections. Note that only devices deployed inline can block traffic. Because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection. For more information, see Understanding Logging for Blocked and Interactively Blocked Connections.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1669663] 
     Caution Logging blocked TCP connections during a Denial of Service (DoS) attack can affect system performance and overwhelm the database with multiple similar events. Before you enable logging for an Block rule, consider whether the rule monitors traffic on an Internet-facing interface or other interface vulnerable to DoS attack. 
      
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1624238][bookmark: 76698]Interactive Blocking Actions: Allowing Users to Bypass Website Blocks
 
    [bookmark: pgfId-1678946]License: Any
 
    [bookmark: pgfId-1679381]For unencrypted HTTP traffic, the Interactive Block and Interactive Block with reset actions give users a chance to bypass a website block by clicking through a customizable warning page, called an HTTP response page. Interactive Block with reset rules also reset the connection.
 
     
      
    
 
    
 
    [bookmark: pgfId-1681260]Note For decrypted and encrypted (HTTPS) traffic, Interactive Block rules block matching connections without interaction and the system does not display a response page. See Understanding Traffic Decryption for information on configuring the SSL inspection feature to decrypt traffic.
 
     
     
 
    
 
    
 
     
     [image: ] 
    
 
   
 
    
     [bookmark: pgfId-1624256][bookmark: 32625]Allow Action: Allowing and Inspecting Traffic
 
    [bookmark: pgfId-1624260]License: Any
 
    [bookmark: pgfId-1624261]The Allow action allows matching traffic to pass. When you allow traffic, you can use an associated intrusion or file policy (or both) to further inspect and block unencrypted or decrypted network traffic:
 
     
     	 [bookmark: pgfId-1624266]With a Protection license, you can use an i[bookmark: marker-1624265]ntrusion policy to analyze network traffic according to intrusion detection and prevention configurations and, optionally, drop offending packets.
 
     	 [bookmark: pgfId-1624270]Also with a Protection license, you can perform file control using a file policy. File control allows you to detect and block your users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols. 
 
     	 [bookmark: pgfId-1624274]With a Malware license, you can perform network-based advanced malware protection (AMP), also using a file policy. Network-based AMP can inspect files for malware, and optionally block detected malware.
 
    
 
    [bookmark: pgfId-1624275]For instructions on how to associate an intrusion or file policy with an access control rule, see Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-1624279]The diagram below illustrates the types of inspection performed on traffic that meets the conditions of an Allow rule (or a user-bypassed Interactive Block rule; see Interactive Blocking Actions: Allowing Users to Bypass Website Blocks). Notice that file inspection occurs before intrusion inspection; blocked files are not inspected for intrusion-related exploits.
 
    [bookmark: pgfId-1624283]For simplicity, the diagram displays traffic flow for situations where both (or neither) an intrusion and a file policy are associated with an access control rule. You can, however, configure one without the other. Without a file policy, traffic flow is determined by the intrusion policy; without an intrusion policy, traffic flow is determined by the file policy. 
 
    [bookmark: pgfId-1624284]Regardless of whether the traffic is inspected or dropped by an intrusion or file policy, the system can inspect it using network discovery. However, allowing traffic does not automatically guarantee discovery inspection. The system performs discovery only for connections involving IP addresses that are explicitly monitored by your network discovery policy; additionally, application discovery is limited for encrypted sessions. For more information, see Introduction to Network Discovery.
 
    [bookmark: pgfId-1695067]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1624293]You can log allowed network traffic at both the beginning and end of connections.
 
   
 
    
     [bookmark: pgfId-1640228][bookmark: 10709]Limitations to Trusting or Blocking Traffic with Series 3 Devices
 
    [bookmark: pgfId-1640232]License: Any
 
    [bookmark: pgfId-1641994]Supported Devices: Series 3
 
    [bookmark: pgfId-1645342]When you apply an access control policy to a Series 3 device, the system may promote access control rules that meet specific criteria. Promoted rules take advantage of specialized hardware in Series 3 devices to immediately divert or block traffic that does not require deep packet inspection. Their advantage is the speed at which they determine the correct path for the traffic.
 
    [bookmark: pgfId-1653608]Because this evaluation takes place at the hardware level, the system can only use limited information to quickly handle connections by promoting rules. Series 3 devices promote rules that meet all of the following criteria:
 
     
     	 [bookmark: pgfId-1643601]have the  Trust ,  Block , or  Block with reset action
 
     	 [bookmark: pgfId-1643785]use  only simple, network-based conditions: security zone, IP address, VLAN tag, and port
 
     	 [bookmark: pgfId-1683153]are placed above  all other access control rules (regardless of action) that perform deep packet inspection, that is, that have application, URL, user, or geolocation-based conditions
 
     	 [bookmark: pgfId-1683154]are also placed above  all Monitor rules
 
    
 
    [bookmark: pgfId-1645223]Therefore, rules promoted to improve performance are most likely simple Trust or Block rules that are placed either near the top of an access control policy (rules with a low number), or anywhere in a policy that uses only simple, network-based rules. However, the performance benefits realized from rule promotion can cause some unexpected behavior.
 
    [bookmark: pgfId-1640530]Preem[bookmark: marker-1664995]pting Security Intelligence
 
    [bookmark: pgfId-1640407]The system processes promoted rules before an access control policy’s Security Intelligence blacklist. This means that promoted Trust rules can allow blacklisted traffic to pass uninspected through a Series 3 device. For more information on Security Intelligence, see Blacklisting Using Security Intelligence IP Address Reputation.
 
    [bookmark: pgfId-1640577]Preventing HTTP Response Page Display
 
    [bookmark: pgfId-1653440]Web traffic blocked by a promoted Block rule does not cause the system to display the configured HTTP response page to your users, even though the system successfully blocks the traffic. Instead, users requesting prohibited URLs have their connection either reset or time out. For more information on configuring a response page, see Displaying a Custom Web Page for Blocked URLs.
 
    [bookmark: pgfId-1653441]IPv6 Tr[bookmark: marker-1665000]affic Handling
 
    [bookmark: pgfId-1653142]The system can inspect both IPv4 and IPv6 traffic. IPv6 inspection includes the 4in6, 6in4, 6to4, and 6in6 tunneling schemes, and also includes Teredo tunneling when the UDP header specifies port 3544. When evaluating traffic using access control rules with IP address conditions, in most cases Series 3 devices match the IP address you specify against the IP address in the innermost packet header.
 
    [bookmark: pgfId-1653172]However, promoted rules use the IP address in the outermost header to evaluate IPv6 traffic, regardless of whether that traffic is tunneled, and regardless of where the IPv6 header is: innermost or outermost. In other words, when promoted rules evaluate tunneled traffic, only 4in4 traffic uses the innermost header to match against access control rule criteria.
 
    [bookmark: pgfId-1650716]For example, consider a scenario where you are using Series 3 devices to examine 6in4 tunneled traffic sent over an IPv4 network. You create a simple, network-based access control rule that blocks traffic to or from a specific IPv6 address. If the system promotes the rule as a result of its position in the access control policy, the rule has no effect. This is because the system matches the outermost IPv4 header of a tunneled packet to the IPv6 rule condition, which can never trigger. The system handles the traffic as if the rule did not exist, using either a subsequent access control rule or the policy’s default action. 
 
   
 
    
     [bookmark: pgfId-1624318][bookmark: 53927]Adding Comments to a Rule
 
    [bookmark: pgfId-1624322]License: Any
 
    [bookmark: pgfId-1624323]When you create or edit an access control rule, you can add a comment. For example, you might summarize the overall configuration for the benefit of other users, or note when you change a rule and the reason for the change. You can display a list of all comments for a rule along with the user who added each comment and the date the comment was added.
 
     
      
    
 
    
 
    [bookmark: pgfId-1624327]Tip To prompt (or force) FireSIGHT System users to enter a comment when saving an access control rule, see Configuring Access Control Policy Preferences.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1624332]When you save a rule, all comments made since the last save become read-only.
 
    [bookmark: pgfId-1624333]To add a comment to a rule:
 
    [bookmark: pgfId-1624337]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1624338]Step 1 In the access control rule editor, select the Comments tab.
 
    [bookmark: pgfId-1624339]The Comments page appears.
 
    [bookmark: pgfId-1624340]Step 2 Click New Comment.
 
    [bookmark: pgfId-1624341]The New Comment pop-up window appears.
 
    [bookmark: pgfId-1624342]Step 3 Type your comment and click OK.
 
    [bookmark: pgfId-1624343]Your comment is saved. You can edit or delete this comment until you save the rule.
 
    [bookmark: pgfId-1624344]Step 4 Save or continue editing the rule.
 
    [bookmark: pgfId-1624345]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1624347][bookmark: 93138]Managing Access Control Rules in a Policy
 
    [bookmark: pgfId-1624351]License: Any
 
    [bookmark: pgfId-1624352]The Rules tab of the access control policy editor, shown in the following graphic, allows you to add, edit, search, move, enable, disable, delete, and otherwise manage access control rules within your policy.
 
    [bookmark: pgfId-1695091]
 
     
     [image: ] 
    
 
     
     
 
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1624364]Table 14-2 Understanding the Access Control Policy Editor 
 
       
       
        
        	 
          
          [bookmark: pgfId-1624370]Icon 
         
  
        	 
          
          [bookmark: pgfId-1624372]Description 
         
  
        	 
          
          [bookmark: pgfId-1624374]You can... 
         
  
       
 
       
          
        	 
        	 [bookmark: pgfId-1624383]Click an active (yellow) inspection icon to edit the inspection options for the rule; see Controlling Traffic Using Intrusion and File Policies. If the icon is inactive (white), no policy of that type is selected for the rule. 
  
       
 
       
          
        	[bookmark: pgfId-1624393]file and malware inspection
  
       
 
       
          
        	[bookmark: pgfId-1624402]logging
  
        	[bookmark: pgfId-1624404]Click an active (blue) logging icon to edit the logging options for the rule; see Logging Connections Based on Access Control Handling. If the icon is inactive (white), connection logging is disabled for the rule. 
  
       
 
       
          
        	[bookmark: pgfId-1624414]comment
  
        	[bookmark: pgfId-1624416]Click the number in the comment column to add a comment to a rule; see Adding Comments to a Rule. The number indicates how many comments the rule already contains.
  
       
 
       
          
        	[bookmark: pgfId-1624426]warning
  
        	 [bookmark: pgfId-1629804]Hover your pointer over the icon to read the warning, error, or informational text; see Troubleshooting Access Control Policies and Rules.
  
       
 
       
          
        	[bookmark: pgfId-1624439]error
  
       
 
       
          
        	[bookmark: pgfId-1624448]information
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1624452]For information on managing access control rules, see:
 
     
     	 [bookmark: pgfId-1624456]Creating and Editing Access Control Rules
 
     	 [bookmark: pgfId-1624460]Searching Access Control Rules
 
     	 [bookmark: pgfId-1624464]Displaying Rules by Affected Device
 
     	 [bookmark: pgfId-1624468]Enabling and Disabling Rules
 
     	 [bookmark: pgfId-1624472]Changing a Rule's Position or Category
 
    
 
     
      [bookmark: pgfId-1624479][bookmark: 70646]Searc[bookmark: marker-1624478]hing Access Control Rules
 
     [bookmark: pgfId-1624483]License: Any
 
     [bookmark: pgfId-1624484]You can search the list of access control rules for matching values using an alphanumeric string, including spaces and printable, special characters. The search inspects the rule name and any rule condition you have added to the rule. For rule conditions, the search matches any name or value you can add for each condition type (zone, network, application, and so on). This includes individual object names or values, group object names, individual object names or values within a group, and literal values.
 
     [bookmark: pgfId-1624485]You can use complete or partial search strings. The column for matching values is highlighted for each matching rule. For example, if you search on all or part of the string 100Bao, at a minimum, the Applications column is highlighted for each rule where you have added the 100Bao application. If you also have a rule named 100Bao, both the Name and Applications columns are highlighted.
 
     [bookmark: pgfId-1624486]You can navigate to each previous or next matching rule. A status message displays the current match and the total number of matches.
 
     [bookmark: pgfId-1624487]Matches may occur on any page of a multi-page rule list. When the first match is not on the first page, the page where the first match occurs is displayed. Selecting the next match when you are at the last match takes you to the first match, and selecting the previous match when you are at the first match takes you to the last match.
 
     [bookmark: pgfId-1624488]To search for rules:
 
     [bookmark: pgfId-1624492]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1624493]Step 1 In the access control policy editor for the policy you want to search, click the Search Rules prompt, type a search string, then press Enter. You can also use the Tab key or click a blank page area to initiate the search.
 
     [bookmark: pgfId-1624494]Columns for rules with matching values are highlighted, with differentiated highlighting for the indicated (first) match.
 
     [bookmark: pgfId-1624495]Step 2 Find the rules you are interested in:
 
      
       
       	 [bookmark: pgfId-1624502]To navigate between matching rules, click the next-match (
 
      
 
      [image: ] ) or previous-match ( 
      [image: ] ) icon. 
     
 
      
       
       	 [bookmark: pgfId-1624506]To refresh the page and clear the search string and any highlighting, click the clear icon (
 
      
 
      [image: ] ). 
     
 
     [bookmark: pgfId-1624507]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624511][bookmark: 66825]Displaying Rule[bookmark: marker-1624509]s by Affected Device
 
     [bookmark: pgfId-1624515]License: Any
 
     [bookmark: pgfId-1624517]You can filter the access control rules listed in your access control policy to display only the rules that govern traffic for one or more specified devices.
 
     [bookmark: pgfId-1624518]To determine the rules that affect a device, the system uses the access control rules’ zone conditions. A security zone is a logical grouping of interfaces, so, if a zone condition includes an interface, the device that handles traffic where that interface is located is affected by that rule. Rules with no zone condition apply to any zone, and therefore every device. 
 
     [bookmark: pgfId-1624519]Note that filters are cleared if you add a new rule, or if you edit and save an existing rule.
 
     [bookmark: pgfId-1624520]To filter rules by device or device group:
 
     [bookmark: pgfId-1624524]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1624525]Step 1 In the access control policy editor for the policy whose rules you want to filter, click Filter by Device above the list of rules.
 
     [bookmark: pgfId-1624526]The Filter by Device pop-up window appears. If you have added devices or device groups to your policy, a list of targeted devices and device groups appears.
 
     [bookmark: pgfId-1624527]Step 2 Select one or more of the check boxes to display only the rules that apply to those devices or groups. Alternatively, select the All check box to reset and display all of the rules.
 
     [bookmark: pgfId-1624528]Step 3 Click OK.
 
     [bookmark: pgfId-1624529]The page updates to display rules for devices and device groups that you selected and hide rules for devices and device groups that you did not select.
 
     [bookmark: pgfId-1624530]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624532][bookmark: 16685]Enabling and Disabling Rules
 
     [bookmark: pgfId-1624536]License: Any
 
     [bookmark: pgfId-1624537]When you create an access control rule, it is enabled by default. If you disable a rule, the system does not use it to evaluate network traffic and stops generating warnings and errors for that rule. When viewing the list of rules in an access control policy, disabled rules are grayed out, although you can still modify them. Note that you can also enable or disable an access control rule using the rule editor; see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1624541]To change an access control rule’s state:
 
     [bookmark: pgfId-1624545]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1624546]Step 1 In the access control policy editor for the policy that contains the rule you want to enable or disable, right-click the rule and choose a rule state:
 
      
       
       	 [bookmark: pgfId-1624547]To enable an inactive rule, select  State > Enable . 
 
       	 [bookmark: pgfId-1624548]To disable an active rule, select  State > Disable . 
 
      
 
     
 
     [bookmark: pgfId-1624549]Step 2 Click Save to save the policy.
 
     [bookmark: pgfId-1624552]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1624554]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624556][bookmark: 21681]Changing a Rule's Position or Category
 
     [bookmark: pgfId-1624560]License: Any
 
     [bookmark: pgfId-1624561]To help you organize access control rules, every access control policy has three system-provided rule categories: Administrator Rules, Standard Rules, and Root Rules. You cannot move, delete, or rename these categories, although you can create custom categories.
 
     [bookmark: pgfId-1624562]By default, any predefined user role that allows you to modify access control policies also allows you to move and modify access control rules within and among rules categories. You can, however, create custom roles that restrict users from moving and modifying rules.
 
     [bookmark: pgfId-1624563]For more information, see: 
 
      
      	 [bookmark: pgfId-1624567]Moving a Rule
 
      	 [bookmark: pgfId-1624571]Adding a New Rule Category
 
     
 
    
 
     
      [bookmark: pgfId-1624573][bookmark: 72746]Moving a Rule
 
     [bookmark: pgfId-1624577]License: Any
 
     [bookmark: pgfId-1624578]Proper access control rule order reduces the resources required to process network traffic, and prevents rule preemption. By default, any predefined user role that allows you to modify access control policies also allows you to move access control rules within and among rules categories. You can, however, create custom roles that restrict users from moving rules in the system-provided categories.
 
     [bookmark: pgfId-1624579]The following procedure explains how to move one or more rules at a time using the access control policy editor. You can also move individual access control rules using the rule editor; see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1624583]To move a rule:
 
     [bookmark: pgfId-1624587]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1624588]Step 1 In the access control policy editor for the policy that contains the rules you want to move, select the rules by clicking in a blank area for each rule. Use the Ctrl and Shift keys to select multiple rules.
 
     [bookmark: pgfId-1624589]The rules you selected are highlighted.
 
     [bookmark: pgfId-1624590]Step 2 Move the rules. You can cut and paste or drag and drop.
 
     [bookmark: pgfId-1624591]To cut and paste rules into a new location, right-click a selected rule and select Cut. Then, right-click a blank area for a rule next to where you want to paste the cut rules and select Paste above or Paste below. Note that you cannot copy and paste access control rules between two different access control policies.
 
     [bookmark: pgfId-1624592]Step 3 Click Save to save the policy.
 
     [bookmark: pgfId-1624595]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1624597]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1624600][bookmark: 58752]Adding a New Rule Catego[bookmark: marker-1624599]ry
 
     [bookmark: pgfId-1624604]License: Any
 
     [bookmark: pgfId-1624605]To help you organize access control rules, every access control policy has three system-provided rule categories: Administrator Rules, Standard Rules, and Root Rules. You cannot move, delete, or rename these categories, although you can create custom categories between the Standard Rules and Root Rules. 
 
     [bookmark: pgfId-1624606]Adding custom categories allows you to further organize your rules without having to create additional policies. You can rename and delete categories that you add. You cannot move these categories, but you can move rules into, within, and out of them.
 
     [bookmark: pgfId-1624607]Although you can create custom roles that restrict users from moving and modifying rules in the system-provided categories, any user who is allowed to modify access control policies can add rules to custom categories and modify rules in them without restriction.
 
     [bookmark: pgfId-1624608]To add a new category:
 
     [bookmark: pgfId-1624612]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1624613]Step 1 In the access control policy editor for the policy where you want to add a rule category, click Add Category.
 
      
       
     
 
     
 
     [bookmark: pgfId-1624614]Tip If your policy already contains rules, you can click a blank area in the row for an existing rule to set the position of the new category before you add it. You can also right-click an existing rule and select Insert new category.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1624615]The Add Category pop-up window appears.
 
     [bookmark: pgfId-1624616]Step 2 Type a unique category Name.
 
     [bookmark: pgfId-1624617]You can enter an alphanumeric name, including spaces and special printable characters, with up to 30 characters.
 
     [bookmark: pgfId-1624618]Step 3 You have the following choices:
 
      
       
       	 [bookmark: pgfId-1624619]To position the new category immediately above an existing category, select  above Category from the first  Insert drop-down list, then select the category above which you want to position the rule from the second drop-down list.
 
       	 [bookmark: pgfId-1624620]To position the new category rule below an existing rule, select  below rule from the drop-down list, then enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
       	 [bookmark: pgfId-1624621]To position the rule above an existing rule, select  above rule from the drop-down list, then, enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
      
 
     
 
     [bookmark: pgfId-1624622]Step 4 Click OK.
 ) to delete the category. Rules in a category you delete are added to the category above. 
     
 
     [bookmark: pgfId-1624630]Step 5 Click Save to save the policy.
 
     [bookmark: pgfId-1624631]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1631774]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 45216]Controlling Traffic with Network-Based Rules 
      
      
 
     
 
 
    [bookmark: pgfId-1567177]Access control rules within access control policies exert granular control over network traffic logging and handling. Network-based conditions allow you to manage which traffic can traverse your network, using one or more of the following criteria:
 
     
     	 [bookmark: pgfId-1558901]source and destination security zones
 
     	 [bookmark: pgfId-1558959]source and destination IP addresses or geographical locations
 
     	 [bookmark: pgfId-1559004]a packet’s innermost VLAN tag
 
     	 [bookmark: pgfId-1559071]source and destination port, which also includes transport layer protocol and ICMP code options
 
    
 
    [bookmark: pgfId-1572180]You can combine network-based conditions with each other and with other types of conditions to create an access control rule. These access control rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on access control rules, see Tuning Traffic Flow Using Access Control Rules.
 
     
      
    
 
    
 
    [bookmark: pgfId-1577245]Note Hardware-based fast-path rules, Security Intelligence-based traffic filtering, and some decoding and preprocessing occur before network traffic is evaluated by access control rules. You can also configure the SSL inspection feature to block or decrypt encrypted traffic before access control rules evaluate it.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1575961]Table 15-1 License and Model Requirements for Network-Based Access Control Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1575969]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1575971]VLAN Tag 
         
  
        	 
          
          [bookmark: pgfId-1575973]Geolocation Control 
         
  
        	 
          
          [bookmark: pgfId-1575975]All Other Network-Based Control 
         
  
       
 
        
        	[bookmark: pgfId-1575977]license
  
        	[bookmark: pgfId-1575979]Any
  
        	[bookmark: pgfId-1575984]FireSIGHT
  
        	[bookmark: pgfId-1575986]Any
  
       
 
        
        	[bookmark: pgfId-1575988]devices
  
        	[bookmark: pgfId-1575990]Any except ASA FirePOWER
  
        	[bookmark: pgfId-1575998]Series 3
virtual
ASA FirePOWER
  
        	[bookmark: pgfId-1576003]Any
  
       
 
        
        	[bookmark: pgfId-1576008]Defense Centers
  
        	[bookmark: pgfId-1576010]Any
  
        	[bookmark: pgfId-1576012]Any except DC500
  
        	[bookmark: pgfId-1576014]Any
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1570859]For information on building network-based access control rules, see:
 
     
     	 [bookmark: pgfId-1530991]Controlling Traffic by Security Zone
 
     	 [bookmark: pgfId-1531132]Controlling Traffic by Network or Geographical Location
 
     	 [bookmark: pgfId-1531146]Controlling VLAN Traffic
 
     	 [bookmark: pgfId-1531160]Controlling Traffic by Port and ICMP Codes
 
    
 
   
 
    
     [bookmark: pgfId-1530963][bookmark: 64628]Controlling Traffic by Security Zone
 
    [bookmark: pgfId-1531017]License: Any
 
    [bookmark: pgfId-1534790]Zone conditions in access control rules allow you to control traffic by its source and destination security zones. A security zone is a grouping of one or more interfaces, which may be located across multiple devices. An option you choose during a device’s initial setup, called its detection mode, determines how the system initially configures the device’s interfaces, and whether those interfaces belong to a security zone.
 
    [bookmark: pgfId-1535699]As a simple example, when you register device with an Inline detection mode, the Defense Center creates two zones: Internal and External, and assigns the first pair of interfaces on the device to those zones. Hosts connected to the network on the Internal side represent your protected assets.
 
    [bookmark: pgfId-1539358]To extend this scenario, you could deploy additional identically configured devices—managed by the same Defense Center—to protect similar resources in several different locations. Like the first device, each of these devices protects the assets in its Internal security zone.
 
     
      
    
 
    
 
    [bookmark: pgfId-1539543]Tip You are not required to group all internal (or external) interfaces into a single zone. Choose the grouping that makes sense for your deployment and security policies. For more information on creating zones, see Working with Security Zones.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1534133]In this deployment, you may decide that although you want these hosts to have unrestricted access to the Internet, you nevertheless want to protect them by inspecting incoming traffic for intrusions and malware. 
 
    [bookmark: pgfId-1569752]To accomplish this using access control, configure an access control rule with a zone condition where the Destination Zone is set to Internal. This simple access control rule matches traffic that leaves the device from any interface in the Internal zone.
 
    [bookmark: pgfId-1542684]To ensure that the system inspects matching traffic for intrusions and malware, choose a rule action of Allow, then associate this rule with an intrusion and a file policy. For more information, see Using Rule Actions to Determine Traffic Handling and Inspection and Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-1543843]If you want to build a more complex rule, you can add a maximum of 50 zones to each of the Source Zones and Destination Zones in a single zone condition:
 
     
     	 [bookmark: pgfId-1542425]To match traffic  leaving the device from an interface in the zone, add that zone to the  Destination Zones .
 
    
 
    [bookmark: pgfId-1542904]Because devices deployed passively do not transmit traffic, you cannot use a zone comprised of passive interfaces in a Destination Zone condition.
 
     
     	 [bookmark: pgfId-1542594]To match traffic  entering the device from an interface in the zone, add that zone to the  Source Zones .
 
     	 [bookmark: pgfId-1543792]If you add both source and destination zone conditions to a rule, matching traffic must originate from one of the specified source zones  and egress through one of the destination zones. 
 
    
 
    [bookmark: pgfId-1575618]Note that just as all interfaces in a zone must be of the same type (all inline, all passive, all switched, or all routed), all zones used in a zone condition for an access control rule must be of the same type. That is, you cannot write a single rule that matches traffic to or from zones of different types.
 
    [bookmark: pgfId-1575619]When building a zone condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
    [bookmark: pgfId-1540267]To control traffic by zone:
 
    [bookmark: pgfId-1560354]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1535259]Step 1 In the access control policy that targets the devices where you want to control traffic by zone, create a new access control rule or edit an existing rule.
 
    [bookmark: pgfId-1535325]For detailed instructions, see Creating and Editing Access Control Rules.
 
    [bookmark: pgfId-1535342]Step 2 In the rule editor, select the Zones tab.
 
    [bookmark: pgfId-1540095]The Zones tab appears.
 
    [bookmark: pgfId-1540090]Step 3 Find and select the zones you want to add from the Available Zones. 
 
    [bookmark: pgfId-1543163]To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones. 
 
    [bookmark: pgfId-1554235]Click to select a zone. To select multiple zones, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-1542306]Step 4 Click Add to Source or Add to Destination to add the selected zones to the appropriate list. 
 
    [bookmark: pgfId-1543119]You can also drag and drop selected zones.
 
    [bookmark: pgfId-1543927]Step 5 Save or continue editing the rule.
 
    [bookmark: pgfId-1544090]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-1567037]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1531004][bookmark: 20007]Controlling Traffic by Network or Geographical Location
 
    [bookmark: pgfId-1531029]License: feature dependent
 
    [bookmark: pgfId-1531035]Supported Devices: feature dependent
 
    [bookmark: pgfId-1544546]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1544390]Network conditions in access control rules allow you to control traffic by its source and destination IP address. You can either:
 
     
     	 [bookmark: pgfId-1545658]explicitly specify the source and destination IP addresses for the traffic you want to control, or
 
     	 [bookmark: pgfId-1552298]use the geolocation feature, which associates IP addresses with geographical locations, to control traffic based on its source or destination country or continent
 
    
 
    [bookmark: pgfId-1552299]When you build a network-based access control rule condition, you can manually specify IP address and geographical locations. Alternately, you can configure network conditions with network and geolocation objects, which are reusable and associate a name with one or more IP addresses, address blocks, countries, continents, and so on. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1550333]Tip After you create a network or geolocation object, you can use it not only to build access control rules, but also to represent IP addresses in various other places in the system’s web interface. You can create these objects using the object manager; you can also create network objects on-the-fly while you are configuring access control rules. For more information, see Managing Reusable Objects.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1552325]Note that if you want to write rules to control traffic by geographical location, to ensure you are using up-to-date geolocation data to filter your traffic, Cisco strongly recommends you regularly update the geolocation database (GeoDB) on your Defense Center; see Updating the Geolocation Database. 
 
    [bookmark: pgfId-1552335]Additionally, note that while you can perform simple IP address-based access control using any FireSIGHT System appliance and any license, geolocation-based access control requires a FireSIGHT license and is not supported on many Series 2 appliances, nor on Cisco NGIPS for Blue Coat X-Series.
 
    [bookmark: pgfId-1552391]
 
     
      
       
       [bookmark: pgfId-1574051]Table 15-2 License and Model Requirements for Network Conditions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1574057]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1574084]Geolocation Control 
         
  
        	 
          
          [bookmark: pgfId-1574061]IP Address Control 
         
  
       
 
        
        	[bookmark: pgfId-1574063]license
  
        	[bookmark: pgfId-1574089]FireSIGHT
  
        	[bookmark: pgfId-1574067]Any
  
       
 
        
        	[bookmark: pgfId-1574069]devices
  
        	[bookmark: pgfId-1574097]Series 3, virtual, ASA FirePOWER
  
        	[bookmark: pgfId-1574073]Any
  
       
 
        
        	[bookmark: pgfId-1574078]Defense Centers
  
        	[bookmark: pgfId-1574099]Any except DC500
  
        	[bookmark: pgfId-1574082]Any
  
       
 
       
     
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1547710]In this example, a network object group called Private Networks (that comprises the IPv4 and IPv6 Private Networks network objects, not shown) represents your internal networks. The example also manually specifies the example.com IP address, and uses a system-provided North Korea geolocation object to represent North Korea IP addresses.
 
    [bookmark: pgfId-1551274]You can add a maximum of 50 items to each of the Source Networks and Destination Networks in a single network condition, and you can mix network and geolocation-based configurations:
 
     
     	 [bookmark: pgfId-1547805]To match traffic  from an IP address or geographical location, configure the  Source Networks .
 
     	 [bookmark: pgfId-1547811]To match traffic  to an IP address or geographical location, configure the  Destination Networks .
 
    
 
    [bookmark: pgfId-1552042]If you add both source and destination network conditions to a rule, matching traffic must originate from one of the specified IP addresses and be destined for one of the destination IP addresses. 
 
    [bookmark: pgfId-1548865]When building a network condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
    [bookmark: pgfId-1545468]To control traffic by network or geographical location:
 
    [bookmark: pgfId-1560366]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1544449]Step 1 In the access control policy that targets the devices where you want to control traffic by network, create a new access control rule or edit an existing rule.
 
    [bookmark: pgfId-1559562]For detailed instructions, see Creating and Editing Access Control Rules.
 
    [bookmark: pgfId-1544451]Step 2 In the rule editor, select the Networks tab.
 
    [bookmark: pgfId-1544452]The Networks tab appears.
 
    [bookmark: pgfId-1544453]Step 3 Find and select the networks you want to add from the Available Networks, as follows:
 
     
      
      	 [bookmark: pgfId-1544454]Click the Networks tab to display network objects and groups to add; click the Geolocation tab to display geolocation objects. 
 
      	 [bookmark: pgfId-1553093]To add a network object on the fly, which you can then add to the condition, click the add icon (
 
     
 
     [image: ] ) above the 
      Available Networks list; see 
     Working with Network Objects. 
    
 
     
      
      	 [bookmark: pgfId-1544455]To search for network or geolocation objects to add, select the appropriate tab, click the  Search by name or value  prompt above the  Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.
 
     
 
    
 
    [bookmark: pgfId-1552816]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-1544456]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
    [bookmark: pgfId-1544457]You can also drag and drop selected objects.
 
    [bookmark: pgfId-1553181]Step 5 Add any source or destination IP addresses or address blocks that you want to specify manually.
 
    [bookmark: pgfId-1553290]Click the Enter an IP address prompt below the Source Networks or Destination Networks list; then type an IP address or address block and click Add.
 
    [bookmark: pgfId-1544458]Step 6 Save or continue editing the rule.
 
    [bookmark: pgfId-1544459]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-1567069]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1530954][bookmark: 98442]Controlling VLAN Traffic
 
    [bookmark: pgfId-1531045]License: Any 
 
    [bookmark: pgfId-1572786]Supported Devices: Any except ASA FirePOWER
 
    [bookmark: pgfId-1559106]VLAN conditions in access control rules allow you to control VLAN-tagged traffic. The system uses the innermost VLAN tag to identify a packet by VLAN.
 
    [bookmark: pgfId-1553621]When you build a VLAN-based access control rule condition, you can manually specify VLAN tags. Alternately, you can configure VLAN conditions with VLAN tag objects, which are reusable and associate a name with one or more VLAN tags. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1553404]Tip After you create a VLAN tag object, you can use it not only to build access control rules, but also to represent VLAN tags in various other places in the system’s web interface. You can create VLAN tag objects either using the object manager or on-the-fly while you are configuring access control rules. For more information, see Working with VLAN Tag Objects.
 
     
     
 
    
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1553481]You can add a maximum of 50 items to the Selected VLAN Tags in a single VLAN tag condition. When building a VLAN tag condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
    [bookmark: pgfId-1553493]To control traffic by VLAN tag:
 
    [bookmark: pgfId-1560423]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1553495]Step 1 In the access control policy that targets the devices where you want to control traffic by VLAN tag, create a new access control rule or edit an existing rule.
 
    [bookmark: pgfId-1559582]For detailed instructions, see Creating and Editing Access Control Rules.
 
    [bookmark: pgfId-1553497]Step 2 In the rule editor, select the VLAN Tags tab.
 
    [bookmark: pgfId-1553498]The VLAN Tags tab appears.
 
    [bookmark: pgfId-1553499]Step 3 Find and select the VLANs you want to add from the Available VLAN Tags, as follows:
 
     
      
      	 [bookmark: pgfId-1559827]To add a VLAN tag object on the fly, which you can then add to the condition, click the add icon (
 
     
 
     [image: ] ) above the Available VLAN Tags list; see 
     Working with VLAN Tag Objects. 
    
 
     
      
      	 [bookmark: pgfId-1559834]To search for VLAN tag objects and groups to add, click the  Search by name or value  prompt above the  Available VLAN Tags  list, then type either the name of the object, or the value of a VLAN tag in the object. The list updates as you type to display matching objects.
 
     
 
    
 
    [bookmark: pgfId-1553503]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-1553504]Step 4 Click Add to Rule or to add the selected objects to the Selected VLAN Tags list. 
 
    [bookmark: pgfId-1553505]You can also drag and drop selected objects.
 
    [bookmark: pgfId-1553506]Step 5 Add any VLAN tags that you want to specify manually.
 
    [bookmark: pgfId-1553507]Click the Enter a VLAN Tag prompt below the Selected VLAN Tags list; then type a VLAN tag or range and click Add. You can specify any VLAN tag from 1 to 4094; use a hyphen to specify a range of VLAN tags.
 
    [bookmark: pgfId-1553508]Step 6 Save or continue editing the rule.
 
    [bookmark: pgfId-1553509]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-1567097]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1531087][bookmark: 32313]Controlling Traffic by Port and ICMP Codes
 
    [bookmark: pgfId-1531088]License: Any 
 
    [bookmark: pgfId-1554568]Network conditions in access control rules allow you to control traffic by its source and destination port. In this context, “port” refers to one of the following:
 
     
     	 [bookmark: pgfId-1555750]For TCP and UDP, you can control traffic based on the transport layer protocol. The system represents this configuration using the protocol number in parentheses, plus an optional associated port or port range. For example: TCP(6)/22.
 
     	 [bookmark: pgfId-1556466]For ICMP and ICMPv6 (IPv6-ICMP), you can control traffic based on its Internet layer protocol plus an optional type and code. For example: ICMP(1):3:3.
 
     	 [bookmark: pgfId-1556467]You can control traffic using other protocols that do not use ports. 
 
    
 
    [bookmark: pgfId-1556468]When you build a port-based access control rule condition, you can manually specify ports. Alternately, you can configure port conditions with port objects, which are reusable and associate a name with one or more ports. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1555422]Tip After you create a port object, you can use it not only to build access control rules, but also to represent ports in various other places in the system’s web interface. You can create port objects either using the object manager or on-the-fly while you are configuring access control rules. For more information, see Working with Port Objects.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1555946]You can add a maximum of 50 items to each of the Selected Source Ports and Selected Destination Ports lists in a single network condition:
 
     
     	 [bookmark: pgfId-1557513]To match traffic  from a port, configure the  Selected Source Ports .
 
    
 
    [bookmark: pgfId-1557514]If you add only source ports to a condition, you can add ports that use different transport protocols. For example, you can add both DNS over TCP and DNS over UDP as source port conditions in a single access control rule.
 
     
     	 [bookmark: pgfId-1554651]To match traffic  to a port, configure the  Selected Destination Ports .
 
    
 
    [bookmark: pgfId-1574915]If you add only destination ports to a condition, you can add ports that use different transport protocols.
 
     
     	 [bookmark: pgfId-1574916]To match traffic both originating from specific  Selected Source Ports  and destined for specific  Selected Destination Ports , configure both.
 
    
 
    [bookmark: pgfId-1557856]If you add both source and destination ports to a condition, you can only add ports that share a single transport protocol (TCP or UDP). For example, if you add DNS over TCP as a source port, you can add Yahoo Messenger Voice Chat (TCP) as a destination port but not Yahoo Messenger Voice Chat (UDP). 
 
    [bookmark: pgfId-1574217]Keep the following points in mind when building a port condition:
 
     
     	 [bookmark: pgfId-1557253]When you add a destination ICMP port with the type set to 0 or a destination ICMPv6 port with the type set to 129, the access control rule only matches unsolicited echo replies. ICMP echo replies sent in response to ICMP echo requests are ignored. For a rule to match on any ICMP echo, use ICMP type 8 or ICMPv6 type 128.
 
     	 [bookmark: pgfId-1574324]When you use the GRE (47) protocol as a destination port condition, you can only add other network-based conditions to the access control rule, that is, zone, network, and VLAN tag conditions. You cannot save the rule if you add reputation or user-based conditions.
 
    
 
    [bookmark: pgfId-1554660]When building a port condition, warning icons indicate invalid configurations. For example, you can use the object manager to edit in-use port objects so that the rules that use those object groups become invalid. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
    [bookmark: pgfId-1554661]To control traffic by port:
 
    [bookmark: pgfId-1560388]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1554663]Step 1 In the access control policy that targets the devices where you want to control traffic by port, create a new access control rule or edit an existing rule.
 
    [bookmark: pgfId-1559598]For detailed instructions, see Creating and Editing Access Control Rules.
 
    [bookmark: pgfId-1554665]Step 2 In the rule editor, select the Ports tab.
 
    [bookmark: pgfId-1554666]The Ports tab appears.
 
    [bookmark: pgfId-1554667]Step 3 Find and select the ports you want to add from the Available Ports, as follows:
 
     
      
      	 [bookmark: pgfId-1556303]To add a port object on the fly, which you can then add to the condition, click the add icon (
 
     
 
     [image: ] ) above the Available Ports list; see 
     Working with Port Objects. 
    
 
     
      
      	 [bookmark: pgfId-1556304]To search for port objects and groups to add, click the  Search by name or value  prompt above the  Available Ports  list, then type either the name of the object, or the value of a port in the object. The list updates as you type to display matching objects. For example, if you type 80, the Defense Center displays the Cisco-provided HTTP port object.
 
     
 
    
 
    [bookmark: pgfId-1556417]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-1556418]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
    [bookmark: pgfId-1556413]You can also drag and drop selected objects.
 
    [bookmark: pgfId-1556414]Step 5 Add any source or destination ports that you want to specify manually.
 
     
      
      	 [bookmark: pgfId-1556512]For source ports, select either  TCP or  UDP from the  Protocol drop-down list under the  Selected Source Ports list. Then, enter a  Port . You can specify a single port with a value from 0 to 65535.
 
      	 [bookmark: pgfId-1575242]For destination ports, select a protocol (including  All for all protocols) from the  Protocol drop down list under the  Selected Destination Ports list. You can also type the number of an unassigned protocol that does not appear in the list.
 
     
 
    
 
    [bookmark: pgfId-1575243]If you select ICMP or IPv6-ICMP, a pop-up window appears where you can select a type and a related code. For more information on ICMP types and codes, see http://www.iana.org/assignments/icmp-parameters/icmp-parameters.xml and http://www.iana.org/assignments/icmpv6-parameters/icmpv6-parameters.xml.
 
    [bookmark: pgfId-1557895]If you do not want to specify a protocol, or optionally if you specified TCP or UDP, enter a Port. You can specify a single port with a value from 0 to 65535.
 
    [bookmark: pgfId-1556483]Click Add. Note that the Defense Center will not add a port to a rule condition that results in an invalid configuration.
 
    [bookmark: pgfId-1554676]Step 6 Save or continue editing the rule.
 
    [bookmark: pgfId-1554677]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-1567121]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531076]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1575170]Controlling Traffic with Reputation-Based Rules 
      
      
 
     
 
 
    [bookmark: pgfId-1584556]Access control rules within access control policies exert granular control over network traffic logging and handling. Reputation-based conditions in access control rules allow you to manage which traffic can traverse your network, by contextualizing your network traffic and limiting it where appropriate. Access control rules govern the following types of reputation-based control:
 
     
     	 [bookmark: pgfId-1585520]Application conditions allow you to perform  application control , which controls application traffic based on not only individual applications, but also applications’ basic characteristics: type, risk, business relevance, categories, and tags.
 
     	 [bookmark: pgfId-1586256]URL conditions allow you to perform  URL filtering , which controls web traffic based on individual websites, as well as websites’ system-assigned category and reputation.
 
    
 
    [bookmark: pgfId-1588115]You can combine reputation-based conditions with each other and with other types of conditions to create an access control rule. These access control rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on access control rules, see Tuning Traffic Flow Using Access Control Rules.
 
     
      
    
 
    
 
    [bookmark: pgfId-1616381]Note Hardware-based fast-path rules, Security Intelligence-based traffic filtering, and some decoding and preprocessing occur before network traffic is evaluated by access control rules. You can also configure the SSL inspection feature to block or decrypt encrypted traffic before access control rules evaluate it.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1584590]Table 16-1 License and Model Requirements for Reputation-Based Access Control Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1584598]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1584600]Application Control 
         
  
        	 
          
          [bookmark: pgfId-1584602]URL Filtering (cat. & rep.) 
         
  
        	 
          
          [bookmark: pgfId-1584604]URL Filtering (manual) 
         
  
       
 
        
        	[bookmark: pgfId-1584606]license
  
        	[bookmark: pgfId-1584608]Control
  
        	[bookmark: pgfId-1584613]URL Filtering
  
        	[bookmark: pgfId-1584615]Any
  
       
 
        
        	[bookmark: pgfId-1584617]devices
  
        	[bookmark: pgfId-1584619]Any except Series 2 or X-Series
  
        	[bookmark: pgfId-1586782]Any except Series 2
  
        	[bookmark: pgfId-1586823]Any except Series 2
  
       
 
        
        	[bookmark: pgfId-1584637]Defense Centers
  
        	[bookmark: pgfId-1584639]Any
  
        	[bookmark: pgfId-1584641]Any except DC500
  
        	[bookmark: pgfId-1584643]Any
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1575172]For information on adding reputation-based conditions to access control rules, see:
 
     
     	 [bookmark: pgfId-1531026]Controlling Application Traffic
 
     	 [bookmark: pgfId-1532542]Blocking URLs
 
    
 
    [bookmark: pgfId-1587252]The FireSIGHT System can perform other types of reputation-based control, but you do not configure these using access control rules. For more information, see:
 
     
     	 [bookmark: pgfId-1587327]Blacklisting Using Security Intelligence IP Address Reputation explains how to limit traffic based on the reputation of a connection’s origin or destination as a first line of defense.
 
     	 [bookmark: pgfId-1587463]Tuning Intrusion Prevention Performance explains how to detect, track, store, analyze, and block the transmission of malware and other types of prohibited files.
 
    
 
   
 
    
     [bookmark: pgfId-1576835][bookmark: 18784]Controlling Application Traffic
 
    [bookmark: pgfId-1634552]License: Control
 
    [bookmark: pgfId-1634559]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-1634563]When the FireSIGHT System analyzes IP traffic, it can identify and classify the commonly used applications on your network. The system uses this discovery-based application awareness feature to allow you to control application traffic on your network.
 
    [bookmark: pgfId-1627901]Understanding Application Control
 
    [bookmark: pgfId-1573272]Application conditions in access control rules allow you to perform this application control. Within a single access control rule, there are a few ways you can specify applications whose traffic you want to control:
 
     
     	 [bookmark: pgfId-1558740]You can select individual applications, including custom applications.
 
     	 [bookmark: pgfId-1558744]You can use system-provided  application filters , which are named sets of applications organized according to the applications’ basic characteristics: type, risk, business relevance, categories, and tags.
 
     	 [bookmark: pgfId-1558745]You can create and use custom application filters, which group applications (including custom applications) in any way you choose.
 
    
 
    [bookmark: pgfId-1558746]Application filters allow you to quickly create application conditions for access control rules. They simplify policy creation and administration, and grant you assurance that the system will control web traffic as expected. For example, you could create an access control rule that identifies and blocks all high risk, low business relevance applications. If a user attempts to use one of those applications, the session is blocked.
 
    [bookmark: pgfId-1568876]In addition, Cisco frequently updates and adds additional detectors via system and vulnerability database (VDB) updates. You can also create your own detectors and assign characteristics (risk, relevance, and so on) to the applications they detect. By using filters based on application characteristics, you can ensure that the system uses the most up-to-date detectors to monitor application traffic.
 
    [bookmark: pgfId-1627946]Building Application Conditions
 
    [bookmark: pgfId-1574790]For traffic to match an access control rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list.
 
    [bookmark: pgfId-1575751]The following graphic shows the application condition for an access control rule that blocks: a custom group of applications for MyCompany, all applications with high risk and low business relevance, gaming applications, and some individually selected applications.
 
    [bookmark: pgfId-1642160]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1575760]In a single application condition, you can add a maximum of 50 items to the Selected Applications and Filters list. Each of the following counts as an item:
 
     
     	 [bookmark: pgfId-1566267]One or more filters from the  Application Filters list, individually or in custom combination. This item represents set of applications, grouped by characteristic.
 
     	 [bookmark: pgfId-1566268]A filter created by saving an application search in the  Available Applications list. This item represents a set of applications, grouped by substring match.
 
     	 [bookmark: pgfId-1620098]An individual application from the  Available Applications list.
 
    
 
    [bookmark: pgfId-1620099]In the web interface, filters added to a condition are listed above and separately from individually added applications.
 
    [bookmark: pgfId-1620100]Note that when you apply an access control policy, for each rule with an application condition, the system generates a list of unique applications to match. In other words, you may use overlapping filters and individually specified applications to ensure complete coverage.
 
     
      
    
 
    
 
    [bookmark: pgfId-1627995]Note For encrypted traffic, the system can identify and filter traffic using only the applications tagged SSL Protocol. Applications without this tag can only be detected in unencrypted or decrypted traffic. Also, the system assigns the decrypted traffic tag to applications that the system can detect in decrypted traffic only—not encrypted or unencrypted. For information on using the SSL inspection feature to decrypt or block encrypted traffic before the system matches it against access control rules, see Understanding Traffic Decryption.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1620101]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1562643]Matching Traffic with Application Filters
 
     	 [bookmark: pgfId-1562805]Matching Traffic from Individual Applications
 
     	 [bookmark: pgfId-1572852]Adding an Application Condition to an Access Control Rule
 
     	 [bookmark: pgfId-1572886]Limitations to Application Control
 
    
 
     
      [bookmark: pgfId-1564936][bookmark: 69738]Matching Traffic with Application Filters
 
     [bookmark: pgfId-1634763]License: Control
 
     [bookmark: pgfId-1634770]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1634771]When building an application condition in an access control rule, use the Application Filters list to create a set of applications, grouped by characteristic, whose traffic you want to match.
 
     [bookmark: pgfId-1587681]For your convenience, the system characterizes each application that it detects using the criteria described in Table 45-2. You can use these criteria as filters or create custom combinations of filters to perform application control. 
 
     [bookmark: pgfId-1587736]Note that the mechanism for filtering applications within an access control rule is the same as that for creating reusable, custom application filters using the object manager; see Working with Application Filters. You can also save many filters you create on-the-fly in access control rules as new, reusable filters. You cannot save a filter that includes another user-created filter because you cannot nest user-created filters.
 
     [bookmark: pgfId-1569755]Understanding How Filters Are Combined
 
     [bookmark: pgfId-1569794]When you select filters, singly or in combination, the Available Applications list updates to display only the applications that meet your criteria. You can select system-provided filters in combination, but not custom filters.
 
     [bookmark: pgfId-1569756]The system links multiple filters of the same filter type with an OR operation. For example, if you select the Medium and High filters under the Risks type, the resulting filter is:
 
      
      [bookmark: pgfId-1569757]Risk: Medium OR High 
     
 
     [bookmark: pgfId-1569758]If the Medium filter contains 110 applications and the High filter contains 82 applications, the system displays all 192 applications in the Available Applications list.
 
     [bookmark: pgfId-1569759]The system links different types of filters with an AND operation. For example, if you select the Medium and High filters under the Risks type, and the Medium and High filters under the Business Relevance type, the resulting filter is:
 
      
      [bookmark: pgfId-1569760]Risk: Medium OR High
AND
Business Relevance: Medium OR High 
     
 
     [bookmark: pgfId-1569761]In this case, the system displays only those applications that are included in both the Medium or High Risk type AND the Medium or High Business Relevance type.
 
     [bookmark: pgfId-1568671]Finding and Selecting Filters
 
     [bookmark: pgfId-1570169]To select filters, click the arrow next to a filter type to expand it, then select or clear the check box next to each filter whose applications you want to display or hide. You can also right-click a system-provided filter type (Risks, Business Relevance, Types, Categories, or Tags) and select Check All or Uncheck All.
 
     [bookmark: pgfId-1571026]To search for filters, click the Search by name prompt above the Available Filters list, then type a name. The list updates as you type to display matching filters.
 
     [bookmark: pgfId-1571022]After you are done selecting filters, use the Available Applications list to add those filters to the rule; see Matching Traffic from Individual Applications.
 
    
 
     
      [bookmark: pgfId-1558774][bookmark: 60208]Matching Traffic from Individual Applications
 
     [bookmark: pgfId-1634705]License: Control
 
     [bookmark: pgfId-1634712]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1634713]When building an application condition in an access control rule, use the Available Applications list to select the applications whose traffic you want to match. 
 
     [bookmark: pgfId-1563411]Browsing the List of Applications
 
     [bookmark: pgfId-1563413]When you first start to build the condition the list is unconstrained, and displays every application the system detects, 100 at a time:
 
      
      	 [bookmark: pgfId-1561750]To page through the applications, click the arrows underneath the list. 
 
      	 [bookmark: pgfId-1561801]To display a pop-up window with summary information about the application’s characteristics, as well as Internet search links that you can follow, click the information icon (
 
      [image: ] ) next to an application. 
     
 
     [bookmark: pgfId-1561898][bookmark: 42058]Finding Applications to Match
 
     [bookmark: pgfId-1563379]To help you find the applications you want to match, you can constrain the Available Applications list in the following ways:
 
      
      	 [bookmark: pgfId-1561862]To search for applications, click the  Search by name prompt above the list, then type a name. The list updates as you type to display matching applications.
 
      	 [bookmark: pgfId-1624527]To constrain the applications by applying a filter, use the  Application Filters list (see Matching Traffic with Application Filters). The  Available Applications list updates as you apply filters. For your convenience, the system uses an unlock icon (
 
      [image: ] ) to mark applications that the system can identify only in decrypted traffic—not encrypted or unencrypted. 
     
 
     [bookmark: pgfId-1624529]Once constrained, an All apps matching the filter option appears at the top of the Available Applications list. This option allows you to add all the applications in the constrained list to the Selected Applications and Filters list, all at once.
 
      
       
     
 
     
 
     [bookmark: pgfId-1563964]Note If you select one or more filters in the Application Filters list and also search the Available Applications list, your selections and the search-filtered Available Applications list are combined using an AND operation. That is, the All apps matching the filter condition includes all the individual conditions currently displayed in the Available Applications list as well as the search string entered above the Available Applications list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1563965]Selecting Single Applications to Match in a Condition
 
     [bookmark: pgfId-1563966]After you find an application you want to match, click to select it. To select multiple applications, use the Shift and Ctrl keys, or right-click and select Select All to select all applications in the current constrained view.
 
     [bookmark: pgfId-1564320]In a single application condition, you can match a maximum of 50 applications by selecting them individually; to add more than 50 you must either create multiple access control rules or use filters to group applications.
 
     [bookmark: pgfId-1563576]Selecting All Applications Matching a Filter for a Condition
 
     [bookmark: pgfId-1566972]Once constrained by either searching or using the filters in the Application Filters list, the All apps matching the filter option appears at the top of the Available Applications list.
 
     [bookmark: pgfId-1566973]This option allows you to add the entire set of applications in the constrained Available Applications list to the Selected Applications and Filters list, at once. In contrast to adding applications individually, adding this set of applications counts as only one item against the maximum of 50, regardless of the number of individual applications that comprise it.
 
     [bookmark: pgfId-1566522]When you build an application condition this way, the name of the filter you add to the Selected Applications and Filters list is a concatenation of the filter types represented in the filter plus the names of up to three filters for each type. More than three filters of the same type are followed by an ellipsis (...). For example, the following filter name includes two filters under the Risks type and four under Business Relevance:
 
      
      [bookmark: pgfId-1558778]Risks: Medium, High Business Relevance: Low, Medium, High,... 
     
 
     [bookmark: pgfId-1611651]Filter types that are not represented in a filter you add with All apps matching the filter are not included in the name of the filter you add. The instructional text that is displayed when you hover your pointer over the filter name in the Selected Applications and Filters list indicates that these filter types are set to any; that is, these filter types do not constrain the filter, so any value is allowed for these.
 
     [bookmark: pgfId-1611652]You can add multiple instances of All apps matching the filter to an application condition, with each instance counting as a separate item in the Selected Applications and Filters list. For example, you could add all high risk applications as one item, clear your selections, then add all low business relevance applications as another item. This application condition matches applications that are high risk OR have low business relevance.
 
    
 
     
      [bookmark: pgfId-1531151][bookmark: 67401]Adding an Application Condition to an Access Control Rule
 
     [bookmark: pgfId-1584260]License: Control
 
     [bookmark: pgfId-1575319]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1573386]For traffic to match an access control rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list. 
 
     [bookmark: pgfId-1573605]You can add a maximum of 50 items per condition, and filters added to a condition are listed above and separately from individually added applications. When building an application condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-1577124]To control application traffic:
 
     [bookmark: pgfId-1577125]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1577126]Step 1 In the access control policy that targets the devices where you want to control traffic by application, create a new access control rule or edit an existing rule.
 
     [bookmark: pgfId-1560033]For detailed instructions, see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1560034]Step 2 In the rule editor, select the Applications tab.
 
     [bookmark: pgfId-1560035]The Applications tab appears.
 
     [bookmark: pgfId-1567451]Step 3 Optionally, use filters to constrain the list of applications displayed in the Available Applications list.
 
     [bookmark: pgfId-1570031]Select one or more filters in the Application Filters list. For more information, see Matching Traffic with Application Filters.
 
     [bookmark: pgfId-1571235]Step 4 Find and select the applications you want to add from the Available Applications list.
 ) marks applications that the system can identify only in decrypted traffic—not encrypted or unencrypted. For more information, see 
     Matching Traffic from Individual Applications. 
     
 
     [bookmark: pgfId-1571711]Step 5 Click Add to Rule to add the selected applications to the Selected Applications and Filters list. 
 
     [bookmark: pgfId-1571784]You can also drag and drop selected applications and filters. Filters appear under the heading Filters, and applications appear under the heading Applications.
 
      
       
     
 
     
 
     [bookmark: pgfId-1571857]Tip Before you add another filter to this application condition, click Clear All Filters to clear your existing selections.
 
      
      
 
     
 
     
 list to save a custom filter comprised of all the individual applications and filters currently in the list. 
     
 
     [bookmark: pgfId-1571820]Use the object manager to manage this on-the-fly-created filter; see Working with Application Filters. Note that you cannot save a filter that includes another user-created filter; you cannot nest user-created filters.
 
     [bookmark: pgfId-1560047]Step 7 Save or continue editing the rule.
 
     [bookmark: pgfId-1560048]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1580965]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1552081][bookmark: 67476]Limitations to Application Control
 
     [bookmark: pgfId-1584285]License: Control
 
     [bookmark: pgfId-1575356]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1552090]Keep the following points in mind when performing application control.
 
     [bookmark: pgfId-1552091]Speed of Application Identification
 
     [bookmark: pgfId-1552092]The system cannot perform application control before:
 
      
      	 [bookmark: pgfId-1552093]a monitored connection is established between a client and server, and 
 
      	 [bookmark: pgfId-1552094]the system identifies the application in the session
 
     
 ). 
     
 
     [bookmark: pgfId-1552097]The allowed packets are inspected by the access control policy’s default intrusion policy (not the default action intrusion policy nor the almost-matched rule’s intrusion policy). For more information, see Setting the Default Intrusion Policy for Access Control.
 
     [bookmark: pgfId-1552098]After the system completes its identification, the system applies the access control rule action, as well as any associated intrusion and file policy, to the remaining session traffic that matches its application condition.
 
     [bookmark: pgfId-1624559]Handling Encrypted Traffic
 
     [bookmark: pgfId-1626988]The system can identify and filter unencrypted application traffic that becomes encrypted using StartTLS, such as SMTPS, POPS, FTPS, TelnetS, and IMAPS. In addition, it can identify certain encrypted applications based on the Server Name Indication in the TLS client hello message, or the server certificate subject distinguished name value.
 
     [bookmark: pgfId-1626980]These applications are tagged SSL Protocol. Applications without this tag can only be detected in unencrypted or decrypted traffic. For information on using the SSL inspection feature to decrypt or block encrypted traffic before the system matches it against access control rules, see Understanding Traffic Decryption.
 
     [bookmark: pgfId-1552375]Handling Application Traffic Packets Without Payloads
 
     [bookmark: pgfId-1592237]The system applies the default policy action to packets that do not have a payload in a connection where an application is identified.
 
     [bookmark: pgfId-1592238]Handling Referred Traffic
 
     [bookmark: pgfId-1552489]To create a rule to act on traffic referred by a web server, such as advertisement traffic, add a condition for the referred application rather than the referring application. For more information, see Special Considerations: Referred Web Applications.
 
     [bookmark: pgfId-1552410]Automatically Enabling Application Detectors
 
     [bookmark: pgfId-1552508]At least one detector must be enabled (see Activating and Deactivating Detectors) for each application rule condition in the policy. If no detector is enabled for an application, the system automatically enables all system-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.
 
     [bookmark: pgfId-1583941]Controlling Application Traffic That Uses Multiple Protocols (Sky[bookmark: marker-1612766]pe)
 
     [bookmark: pgfId-1596814]The system can detect multiple types of Skype application traffic. When building an application condition to control Skype traffic, select the Skype tag from the Application Filters list rather than selecting individual applications. This ensures that the system can detect and control all Skype traffic the same way. For more information, see Matching Traffic with Application Filters.
 
    
 
   
 
    
     [bookmark: pgfId-1531028][bookmark: 77351]Blocking URLs
 
    [bookmark: pgfId-1531053]License: feature dependent
 
    [bookmark: pgfId-1575388]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-1533786]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1533906]URL conditions in access control rules allow you to limit the websites that users on your network can access. This feature is called URL filtering. There are two ways you can use access control to specify URLs you want to block (or, conversely, allow):
 
     
     	 [bookmark: pgfId-1533907]With any license, you can manually specify individual URLs or groups of URLs to achieve granular, custom control over web traffic.
 
     	 [bookmark: pgfId-1533988]With a URL Filtering license, you can also control access to websites based on the URL’s general classification, or  category , and risk level, or  reputation . The system displays this category and reputation data in connection logs, intrusion events, and application details. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1618814]Note To see URL category and reputation information in events, you must create at least one access control rule with a URL condition.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1534027]When you block a website, you can either allow the user’s browser its default behavior, or you can display a generic system-provided or custom page. You can also give users a chance to bypass a website block by clicking through a warning page.
 
    [bookmark: pgfId-1642993]Due to memory resources, the ASA5506-X, ASA5506H-X, ASA5506W-X, ASA5508-X, ASA5512-X, ASA5515-X, ASA5516-X, ASA5525-X, and 71xx Family devices use a smaller URL category database than the database used by other models, including the ASA5545-X, ASA5555-X, and the ASA5585-X. 
 
    [bookmark: pgfId-1642997]The smaller database does not contain entries for some popular sub-domains of popular domains. As an example, mail.google.com is not in the smaller database and as a result mail.google.com is categorized as a search engine and not web-based mail as expected.
 
    [bookmark: pgfId-1628254]Handling Encrypted Web Traffic
 
    [bookmark: pgfId-1608391]If you configure SSL inspection (see Understanding Traffic Decryption) to decrypt encrypted traffic, access control rules evaluate the decrypted traffic as if it were unencrypted. However, if your SSL inspection configuration allows encrypted connections to pass undecrypted, or if you do not configure SSL inspection, access control rules evaluate encrypted traffic.
 
    [bookmark: pgfId-1619452]When evaluating web traffic using access control rules with URL conditions, the system matches HTTPS traffic based on the subject common name in the public key certificate used to encrypt the traffic. Also, the system disregards subdomains within the subject common name, so do not include subdomain information when manually filtering HTTPS URLs. For example, use example.com rather than www.example.com.
 
    [bookmark: pgfId-1619110]Also, the system disregards the encryption protocol (HTTP vs HTTPS). This occurs for both manual and reputation-based URL conditions. In other words, access control rules treat traffic to the following websites identically:
 
     
     	 [bookmark: pgfId-1606014]http://example.com/
 
     	 [bookmark: pgfId-1608408]https://example.com/
 
    
 
    [bookmark: pgfId-1608410]To configure an access control rule that matches only HTTP or HTTPS traffic, add an application condition to the rule. For example, you could allow HTTPS access to a site while disallowing HTTP access by constructing two access control rules, each with an application and URL condition. 
 
     
     [bookmark: pgfId-1603838]Action: Block 
    
 
     
     [bookmark: pgfId-1603839]Application: HTTP 
    
 
     
     [bookmark: pgfId-1619055]URL: example.com 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1619986]Note By default, the system disables intrusion and file inspection of encrypted payloads as soon as it detects an attempt to encrypt the session. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured. For more information, see Using the SSL Preprocessor.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1588420]Table 16-2 License and Model Requirements for URL Filtering 
 
       
       
        
        	 
          
          [bookmark: pgfId-1588426]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1588428]Category & Reputation-Based 
         
  
        	 
          
          [bookmark: pgfId-1588430]Manual 
         
  
       
 
        
        	[bookmark: pgfId-1588432]license
  
        	[bookmark: pgfId-1588437]URL Filtering
  
        	[bookmark: pgfId-1588439]Any
  
       
 
        
        	[bookmark: pgfId-1588441]devices
  
        	[bookmark: pgfId-1588446]Any except Series 2
  
        	[bookmark: pgfId-1588451]Any except Series 2
  
       
 
        
        	[bookmark: pgfId-1588456]Defense Centers
  
        	[bookmark: pgfId-1588458]Any except DC500
  
        	[bookmark: pgfId-1588460]Any
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1547124]For more information, see:
 
     
     	 [bookmark: pgfId-1547128]Performing Reputation-Based URL Blocking
 
     	 [bookmark: pgfId-1588156]Performing Manual URL Blocking
 
     	 [bookmark: pgfId-1588279]Limitations to URL Detection and Blocking
 
     	 [bookmark: pgfId-1588192]Allowing Users to Bypass URL Blocks
 
     	 [bookmark: pgfId-1588197]Displaying a Custom Web Page for Blocked URLs
 
    
 
     
      [bookmark: pgfId-1531045][bookmark: 91509]Performing Reputation-Based URL Blocking
 
     [bookmark: pgfId-1537250]License: URL Filtering
 
     [bookmark: pgfId-1575409]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1537252]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1536219]With a URL Filtering license, you can control your users’ access to websites based on the category and reputation of requested URLs, which the FireSIGHT System obtains from the Cisco cloud:
 
      
      	 [bookmark: pgfId-1536220]The URL  category is a general classification for the URL. For example, ebay.com belongs to the  Auctions category, and monster.com belongs to the  Job Search category. A URL can belong to more than one category.
 
      	 [bookmark: pgfId-1628654]The URL  reputation represents how likely the URL is to be used for purposes that might be against your organization’s security policy. A URL’s risk can range from  High Risk (level 1) to  Well Known (level 5).
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1628662]Note Before access control rules with category and reputation-based URL conditions can take effect, you must enable communications with the Cisco cloud. This allows the Defense Center to retrieve URL data. For more information, see Enabling Cloud Communications.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1628566]Advantages to Reputation-Based URL Blocking
 
     [bookmark: pgfId-1628805]URL categories and reputations allow you to quickly create URL conditions for access control rules. For example, you could create an access control rule that identifies and blocks all High Risk URLs in the Abused Drugs category. If a user attempts to browse to any URL with that category and reputation combination, the session is blocked.
 
     [bookmark: pgfId-1628570]Using category and reputation data from the Cisco cloud also simplifies policy creation and administration. It grants you assurance that the system will control web traffic as expected. Finally, because the cloud is continually updated with new URLs, as well as new categories and risks for existing URLs, you can ensure that the system uses up-to-date information to filter requested URLs. Malicious sites that represent security threats such as malware, spam, botnets, and phishing may appear and disappear faster than you can update and apply new policies.
 
     [bookmark: pgfId-1536915]Some examples include:
 
      
      	 [bookmark: pgfId-1536916]If a rule blocks all gaming sites, as new domains get registered and classified as  Gaming , the system can block those sites automatically.
 
      	 [bookmark: pgfId-1536917]If a rule blocks all malware sites, and a blog page gets infected with malware, the cloud can recategorize the URL from  Blog to  Malware and the system can block that site.
 
      	 [bookmark: pgfId-1536918]If a rule blocks high-risk social networking sites, and somebody posts a link on their profile page that contains links to malicious payloads, the cloud can change the reputation of that page from  Benign sites to  High Risk so the system can block it.
 
     
 
     [bookmark: pgfId-1540720]Note that if the cloud does not know the category or reputation of a URL, or if the Defense Center cannot contact the cloud, that URL does not trigger access control rules with category or reputation-based URL conditions. You cannot assign categories or reputations to URLs manually.
 
     [bookmark: pgfId-1541534]Building URL Conditions
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1551734]You can add a maximum of 50 items to the Selected URLs to match in a single URL condition. Each URL category, optionally qualified by reputation, counts as a single item. Note that you can also use literal URLs and URL objects in URL conditions, but you cannot qualify these items with a reputation. For more information, see Performing Manual URL Blocking.
 
     [bookmark: pgfId-1542269]The following table summarizes how you build the condition shown above. Note that you cannot qualify a literal URL or URL object with a reputation.
 
     [bookmark: pgfId-1542307]
 
      
       
        
        [bookmark: pgfId-1542272]Table 16-3 Example: Building A URL Condition 
 
        
        
         
         	 
           
           [bookmark: pgfId-1542278]To block... 
          
  
         	 
           
           [bookmark: pgfId-1542280]Select this Category or URL Object... 
          
  
         	 
           
           [bookmark: pgfId-1542282]And this Reputation... 
          
  
        
 
         
         	[bookmark: pgfId-1542284]malware sites, regardless of reputation
  
         	[bookmark: pgfId-1542286]Malware Sites
  
         	[bookmark: pgfId-1542288]Any
  
        
 
         
         	[bookmark: pgfId-1542290]any URL with a high risk (level 1)
  
         	[bookmark: pgfId-1542292]Any
  
         	[bookmark: pgfId-1542294]1 - High Risk
  
        
 
         
         	[bookmark: pgfId-1542296]social networking sites with a risk greater than benign (levels 1 through 3)
  
         	[bookmark: pgfId-1542298]Social Network
  
         	[bookmark: pgfId-1542300]3 - Benign sites with security risks
  
        
 
         
         	[bookmark: pgfId-1542302]example.com
  
         	[bookmark: pgfId-1542304]the URL object named example.com
  
         	[bookmark: pgfId-1542306]none
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1547034]When building a URL condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1640166] 
      Caution Adding o r removing a URL category or reputation condition in an access control rule restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1538373]To control traffic by requested URL using category and reputation data:
 
     [bookmark: pgfId-1575560]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1589244]Step 1 In the access control policy that targets the devices where you want to control traffic by URL, create a new access control rule or edit an existing rule.
 
     [bookmark: pgfId-1538378]For detailed instructions, see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1538380]Step 2 In the rule editor, select the URLs tab.
 
     [bookmark: pgfId-1543528]The URLs tab appears.
 
     [bookmark: pgfId-1544159]Step 3 Find and select the categories of URL you want to add from the Categories and URLs list. To match web traffic regardless of category, select Any category.
 
     [bookmark: pgfId-1544161]To search for categories to add, click the Search by name or value prompt above the Categories and URLs list, then type the category name. The list updates as you type to display matching categories.
 
     [bookmark: pgfId-1551788]To select a category, click it. To select multiple categories, use the Shift and Ctrl keys. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1551789]Tip Although you can right-click and Select All categories, adding all categories this way exceeds the 50-item maximum for an access control rule. Instead, use Any.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1544199]Step 4 Optionally, qualify your category selections by clicking a reputation level from the Reputations list. If you do not specify a reputation level, the system defaults to Any, meaning all levels. 
 
     [bookmark: pgfId-1544369]You can only select one reputation level. When you choose a reputation level, the access control rule behaves differently depending on its purpose:
 
      
       
       	 [bookmark: pgfId-1544337]If the rule blocks or monitors web access (the rule action is  Block ,  Block with reset ,  Interactive Block ,  Interactive Block with reset , or  Monitor ) selecting a reputation level also selects all reputations more severe than that level. For example, if you configure a rule to block or monitor  Suspicious sites (level 2), it also automatically blocks or monitors  High risk (level 1) sites.
 
       	 [bookmark: pgfId-1544339]If the rule allows web access, whether to trust or further inspect it (the rule action is  Allow  or  Trust ), selecting a reputation level also selects all reputations less severe than that level. For example, if you configure a rule to allow  Benign sites (level 4), it also automatically allows  Well known (level 5) sites.
 
      
 
     
 
     [bookmark: pgfId-1544302]If you change the rule action for a rule, the system automatically changes the reputation levels in URL conditions according to the above points.
 
     [bookmark: pgfId-1544578]Step 5 Click Add to Rule or drag and drop the selected items to add them to the Selected URLs list. 
 
     [bookmark: pgfId-1539328]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-1539329]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1580972]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537119][bookmark: 88336]Performing Manual URL Blocking
 
     [bookmark: pgfId-1575439]License: Any
 
     [bookmark: pgfId-1575480]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1575447]To supplement or selectively override URL filtering by category and reputation, you can control web traffic by manually specifying individual URLs or groups of URLs. This allows you to achieve granular, custom control over allowed and blocked web traffic. You can also perform this type of URL filtering without a special license.
 
     [bookmark: pgfId-1544810]To manually specify URLs to allow or block in an access control rule, you can type in a single literal URL. Or, you can configure URL conditions using URL objects, which are reusable and associate a name with a URL or IP address.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537539]Tip After you create a URL object, you can use it not only to build access control rules, but also to represent URLs in various other places in the system’s web interface. You can create these objects using the object manager; you can also create URL objects on-the-fly while you are configuring access control rules. For more information, see Working with URL Objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537693]Manually Specifying URLs in URL Conditions
 
     [bookmark: pgfId-1628962]Although manual entry gives you precise control over allowed and blocked web traffic, you cannot qualify a manually specified URL with a reputation. Additionally, you must make sure that your rules do not have unintended consequences. To determine whether network traffic matches a URL condition, the system performs a simple substring match. If the value of a URL object or manually typed URL matches any part of a URL requested by a monitored host, the URL condition of the access control rule is satisfied.
 
     [bookmark: pgfId-1546314]Therefore, when manually specifying URLs in URL conditions, including in URL objects, carefully consider other traffic that might be affected. For example, if you allow all traffic to example.com, your users could browse to URLs including:
 
      
      	 [bookmark: pgfId-1537584]http://example.com/
 
      	 [bookmark: pgfId-1537585]http://example.com/newexample
 
      	 [bookmark: pgfId-1537586]http://www.example.com/
 
     
 
     [bookmark: pgfId-1611868]As another example, consider a scenario where you want to explicitly block ign.com (a gaming site). However, substring matching means that blocking ign.com also blocks verisign.com, which might not be your intent.
 
     [bookmark: pgfId-1628879]Manually Blocking Encrypted Web Traffic 
 
     [bookmark: pgfId-1611994]Note that access control rules handle encrypted traffic when your SSL inspection configuration allows it to pass, or if you do not configure SSL inspection; see Understanding Traffic Decryption. URL conditions in access control rules:
 
      
      	 [bookmark: pgfId-1612641]disregard the encryption protocol of web traffic (HTTP vs HTTPS)
 
     
 
     [bookmark: pgfId-1612642]For example, access control rules treat traffic to http://example.com/ the same as traffic to https://example.com/. To configure an access control rule that matches only HTTP or HTTPS traffic, add an application condition to the rule. For more information, see Blocking URLs.
 
      
      	 [bookmark: pgfId-1612681]match HTTPS traffic based on the subject common name in the public key certificate used to encrypt the traffic, and also disregard subdomains within the subject common name
 
     
 
     [bookmark: pgfId-1612728]Do not include subdomain information when manually filtering HTTPS traffic.
 
     [bookmark: pgfId-1546956]When building a URL condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
     [bookmark: pgfId-1544739]To control web traffic by manually specifying URLs to allow or block:
 
     [bookmark: pgfId-1575573]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1544741]Step 1 In the access control policy that targets the devices where you want to control traffic by URL, create a new access control rule or edit an existing rule.
 
     [bookmark: pgfId-1544744]For detailed instructions, see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1544746]Step 2 In the rule editor, select the URLs tab.
 
     [bookmark: pgfId-1544747]The URLs tab appears.
 
     [bookmark: pgfId-1544748]Step 3 Find and select the URL objects and groups you want to add from the Categories and URLs list:
 
      
       
       	 [bookmark: pgfId-1545325]To add a URL object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Categories and URLs list; see 
      Working with URL Objects. 
     
 
      
       
       	 [bookmark: pgfId-1545551]To search for URL objects and groups to add, click the  Search by name or value  prompt above the  Categories and URLs  list, then type either the name of the object, or the value of a URL or IP address in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-1544750]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys. Although you can right-click and Select All URL objects and categories, adding URLs this way exceeds the 50-item maximum for an access control rule.
 
     [bookmark: pgfId-1544757]Step 4 Click Add to Rule or to add the selected items to the Selected URLs list.
 
     [bookmark: pgfId-1544758]You can also drag and drop selected items.
 
     [bookmark: pgfId-1545625]Step 5 Add any literal URLs that you want to specify manually. You cannot use wildcards (*) in this field.
 
     [bookmark: pgfId-1545626]Click the Enter URL prompt below the Selected URLs list; then type a URL or IP address and click Add.
 
     [bookmark: pgfId-1544759]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-1544760]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1580992]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1530942][bookmark: 12501]Limitations to URL Detection and Blocking
 
     [bookmark: pgfId-1548535]License: Any
 
     [bookmark: pgfId-1575501]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1536501]Keep the following points in mind when performing URL detection and blocking.
 
     [bookmark: pgfId-1536641]Speed of URL Identification
 
     [bookmark: pgfId-1536689]The system cannot filter URLs before:
 
      
      	 [bookmark: pgfId-1547252]a monitored connection is established between a client and server
 
      	 [bookmark: pgfId-1547264]the system identifies the HTTP or HTTPS application in the session
 
      	 [bookmark: pgfId-1627201]the system identifies the requested URL (for encrypted sessions, from either the client hello message or the server certificate)
 
     
 ). 
     
 
     [bookmark: pgfId-1547145]The allowed packets are inspected by the access control policy’s default intrusion policy (not the default action intrusion policy nor the almost-matched rule’s intrusion policy). For more information, see Setting the Default Intrusion Policy for Access Control.
 
     [bookmark: pgfId-1629230]After the system completes its identification, the system applies the access control rule action, as well as any associated intrusion and file policy, to the remaining session traffic that matches its URL condition.
 
     [bookmark: pgfId-1629231]Handling Encrypted Web Traffic
 
     [bookmark: pgfId-1629232]When evaluating encrypted web traffic using access control rules with URL conditions, the system:
 
      
      	 [bookmark: pgfId-1629545]disregards the encryption protocol; an access control rule matches both HTTPS and HTTP traffic if the rule has a URL condition but not an application condition that specifies the protocol
 
      	 [bookmark: pgfId-1629233]matches HTTPS traffic based on the subject common name in the public key certificate used to encrypt the traffic, and disregards subdomains within the subject common name
 
      	 [bookmark: pgfId-1629236]does not display an HTTP response page, even if you configured one
 
     
 
     [bookmark: pgfId-1629237]HTTP Response Pages
 
     [bookmark: pgfId-1629238]HTTP response pages do not appear when web traffic is blocked:
 
      
      	 [bookmark: pgfId-1625258]and the session is or was encrypted
 
      	 [bookmark: pgfId-1625100]by a Series 3 device as a result of a promoted access control rule
 
      	 [bookmark: pgfId-1625102]in cases where the system does not identify the requested URL in the connection until after the connection has been established and allowed to flow for a few packets, as described above
 
     
 
     [bookmark: pgfId-1625398]For more information, see Displaying a Custom Web Page for Blocked URLs.
 
     [bookmark: pgfId-1536940]Search Query Parameters in URLs
 
     [bookmark: pgfId-1536941]The system does not use search query parameters in the URL to match URL conditions. For example, consider a scenario where you block all shopping traffic. In that case, using a web search to search for amazon.com is not blocked, but browsing to amazon.com is.
 
    
 
     
      [bookmark: pgfId-1538475][bookmark: 70087]Allowing Users to Bypass URL Blocks
 
     [bookmark: pgfId-1584470]License: Any
 
     [bookmark: pgfId-1633737]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1633738]When you block a user’s HTTP web request using an access control rule, setting the rule action to Interactive Block or Interactive Block with reset gives that user a chance to bypass the block by clicking through a warning HTTP response page. You can display a generic system-provided response page or you can enter custom HTML. 
 
     [bookmark: pgfId-1632573]By default, the system allows users to bypass blocks for 10 minutes (600 seconds) without displaying the warning page on subsequent visits. You can set the duration to as long as a year, or you can force the user to bypass the block every time.
 
     [bookmark: pgfId-1632495]If the user does not bypass the block, matching traffic is denied without further inspection; you can also reset the connection. On the other hand, if a user bypasses the block, the system allows the traffic. Allowing this traffic means that you can continue to inspect unencrypted payloads for intrusions, malware, prohibited files, and discovery data. Note that users may have to refresh after bypassing the block to load page elements that did not load.
 
     [bookmark: pgfId-1632580]Note that you configure the interactive HTTP response page separately from the response page you configure for Block rules. For example, you could display the system-provided page to users whose sessions are blocked without interaction, but a custom page to users who can click to continue. For more information, see Displaying a Custom Web Page for Blocked URLs.
 
     [bookmark: pgfId-1631194]Note that in the following situations, the response page does not appear and traffic is blocked without interaction, even if the session matches an Interactive Block rule:
 
      
      	 [bookmark: pgfId-1631196]if the session was or is encrypted; this includes sessions decrypted by the system
 
      	 [bookmark: pgfId-1630241]after a connection has been established and allowed to flow for a few packets so the system can inspect it for requested URLs and application details; see Troubleshooting Access Control Policies and Rules
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1632671]Tip To quickly disable interactive blocking for all rules in an access control policy, display neither the system-provided page nor a custom page. This causes the system to block all connections that match an Interactive Block rule without interaction.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1550239]To allow users to bypass a website block:
 
     [bookmark: pgfId-1575586]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1549830]Step 1 Create an access control rule that matches web traffic with a URL condition.
 
     [bookmark: pgfId-1550419]See Performing Reputation-Based URL Blocking and Performing Manual URL Blocking.
 
     [bookmark: pgfId-1550160]Step 2 Make sure the access control rule action is Interactive Block or Interactive Block with reset.
 
     [bookmark: pgfId-1551192]See Using Rule Actions to Determine Traffic Handling and Inspection.
 
     [bookmark: pgfId-1551194]Step 3 Assume users will bypass the block and choose inspection and logging options for the rule accordingly. As with Allow rules:
 
      
       
       	 [bookmark: pgfId-1551245]You can associate either type of Interactive Block rule with a file and intrusion policy. The system can also use discovery to inspect this user-allowed traffic. For more information, see Controlling Traffic Using Intrusion and File Policies.
 
       	 [bookmark: pgfId-1551237]Logging options for interactively blocked traffic are identical to those in allowed traffic, but keep in mind that if a user does not bypass the interactive block, the system can log only beginning-of-connection events. 
 
      
 
     
 
     [bookmark: pgfId-1550862]Note that when the system initially warns the user, it marks any logged beginning-of-connection event with the Interactive Block or Interactive Block with reset action. If the user bypasses the block, additional connection events logged for the session have an action of Allow. For more information, see Logging Connections Based on Access Control Handling.
 
     [bookmark: pgfId-1593131]Step 4 Optionally, set the amount of time that elapses after a user bypasses a block before the system displays the warning page again.
 
     [bookmark: pgfId-1593127]See Setting the User Bypass Timeout for a Blocked Website.
 
     [bookmark: pgfId-1583899]Step 5 Optionally, create and use a custom page to display to allow users to bypass a block.
 
     [bookmark: pgfId-1583903]See Displaying a Custom Web Page for Blocked URLs.
 
     [bookmark: pgfId-1592982]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1593027][bookmark: 59809]Setting the User Bypass Timeout for a Blocked Website
 
     [bookmark: pgfId-1593031]License: Any
 
     [bookmark: pgfId-1593032]By default, the system allows a user to bypass interactive blocks for 10 minutes (600 seconds) without displaying the warning page on subsequent visits. You can set the duration to as long as a year, or to zero to force the user to bypass the block every time. This limit applies to every Interactive Block rule in the policy. You cannot set the limit per rule.
 
     [bookmark: pgfId-1593033]To customize the length of time before a user bypass expires:
 
     [bookmark: pgfId-1593037]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1593038]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1593039]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
     
 
     [bookmark: pgfId-1593044]The access control policy editor appears.
 
     [bookmark: pgfId-1593045]Step 3 Select the Advanced tab. 
 
     [bookmark: pgfId-1593046]Advanced settings for the access control policy appear. 
 ) next to General Settings. 
     
 
     [bookmark: pgfId-1593051]The General Settings pop-up window appears.
 
     [bookmark: pgfId-1593052]Step 5 In the Allow an Interactive Block to bypass blocking for (seconds) field, type the number of seconds that must elapse before the user bypass expires.
 
     [bookmark: pgfId-1593053]You can specify any number of seconds from zero to 31536000 (one year). Specifying zero forces your users to bypass the block every time.
 
     [bookmark: pgfId-1593054]Step 6 Click OK.
 
     [bookmark: pgfId-1593665]Advanced settings for the access control policy appear.
 
     [bookmark: pgfId-1593681]Step 7 Click Save.
 
     [bookmark: pgfId-1593668]You must apply the access control policy for your changes to take effect. For more information, see Applying an Access Control Policy.
 
     [bookmark: pgfId-1593669]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1592986][bookmark: 49497]Displaying a Custo[bookmark: marker-1592984]m Web Page for Blocked URLs
 
     [bookmark: pgfId-1592990]License: Any
 
     [bookmark: pgfId-1575546]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1551677]When the system blocks a user’s HTTP web request, what the user sees in a browser depends on how you block the session, using the access control rule’s action. You should select:
 
      
      	 [bookmark: pgfId-1548904] Block or  Block with reset to deny the connection. A blocked session times out; the system resets Block with reset connections. However, for both blocking actions, you can override the default browser or server page with a custom page that explains that the connection was denied. The system calls this custom page an  HTTP response page . 
 
      	 [bookmark: pgfId-1598262] Interactive Block or  Interactive Block with reset if you want to display an  interactive HTTP response page that warns users, but also allows them to click a button to continue or refresh the page to load the originally requested site. Users may have to refresh after bypassing the response page to load page elements that did not load.
 
     
 
     [bookmark: pgfId-1609529]You can either display a generic system-provided response page, or you can enter custom HTML. When you enter custom text, a counter shows how many characters you have used.
 
     [bookmark: pgfId-1632991]In each access control policy, you configure the interactive HTTP response page separately from the response page you use to block traffic without interaction, that is, using a Block rule. For example, you could display the system-provided page to users whose sessions are blocked without interaction, but a custom page to users who can click to continue.
 
     [bookmark: pgfId-1631368]Reliable display of HTTP response pages to your users depends on your network configuration, traffic loads, and size of the page. If you build a custom response page, keep in mind that a smaller page is more likely to display successfully. 
 
     [bookmark: pgfId-1598271]To configure HTTP response pages:
 
     [bookmark: pgfId-1598275]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1549100]Step 1 Edit the access control policy that targets the devices monitoring your web traffic.
 
     [bookmark: pgfId-1549119]For more information, see Editing Access Control Policies.
 
     [bookmark: pgfId-1549111]Step 2 Select the HTTP Responses tab.
 
     [bookmark: pgfId-1549096]HTTP response page settings for the access control policy appear.
 
     [bookmark: pgfId-1548699]Step 3 For the Block Response Page and the Interactive Block Response Page, select responses from the drop-down lists. For each page, you have the following choices:
 
      
       
       	 [bookmark: pgfId-1548703]To use a generic response, select  System-provided . You can click the view icon (
 
      
 
      [image: ] ) to view the HTML code for this page. 
     
 
      
       
       	 [bookmark: pgfId-1548707]To create a custom response, select  Custom .
 
      
 
     
 ). 
     
 
      
       
       	 [bookmark: pgfId-1548715]To prevent the system from displaying an HTTP response page, select  None . Note that selecting this option for interactively blocked sessions prevents users from clicking to continue; the session is blocked without interaction.
 
      
 
     
 
     [bookmark: pgfId-1548716]Step 4 Click Save.
 
     [bookmark: pgfId-1548717]You must apply the access control policy for your changes to take effect. For more information, see Applying an Access Control Policy.
 
     [bookmark: pgfId-1581275]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1545011][bookmark: 97785]Controlling Traffic Based on Users 
      
      
 
     
 
 
    [bookmark: pgfId-1549561]Access control rules within access control policies exert granular control over network traffic logging and handling. User conditions in access control rules allow you perform user control—to manage which traffic can traverse your network, by limiting traffic based on the LDAP user logged into a host. 
 
    [bookmark: pgfId-1555790]User control works by associating access-controlled users with IP addresses. Deployed agents monitor specified users as they log in and out of hosts or authenticate with Active Directory credentials for other reasons. For example, your organization may use services or applications that rely on Active Directory for centralized authentication.
 
    [bookmark: pgfId-1556865]For traffic to match an access control rule with a user condition, the IP address of either the source or destination host in the monitored session must be associated with a logged in access-controlled user. You can control traffic based on individual users or the groups those users belong to.
 
    [bookmark: pgfId-1549564]You can combine user conditions with each other and with other types of conditions to create an access control rule. These access control rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on access control rules, see Tuning Traffic Flow Using Access Control Rules.
 
     
      
    
 
    
 
    [bookmark: pgfId-1592324]Note Hardware-based fast-path rules, Security Intelligence-based traffic filtering, and some decoding and preprocessing occur before network traffic is evaluated by access control rules. You can also configure the SSL inspection feature to block or decrypt encrypted traffic before access control rules evaluate it.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1560747]User control requires a Control license and is supported only for LDAP users and groups (access-controlled users), using login and logoff records reported by a User Agent monitoring Microsoft Active Directory servers. 
 
    [bookmark: pgfId-1560751]However, with only a FireSIGHT license you can still take advantage of user awareness, which is the basis of user control. User awareness allows you to view agent-reported user activity as well as additional activity for non-access-controlled users, which the system can detect when managed devices examine allowed network traffic for discovery data. The system can identify login attempts over various protocols: AIM, IMAP, LDAP, Oracle, POP3, SIP, FTP, HTTP, and MDNS.
 
    [bookmark: pgfId-1560752]To add context to the user activity reported by the system, you can query an LDAP server in your deployment to retrieve metadata for not only access-controlled users, but also some non-access-controlled users: POP3 and IMAP users detected by user discovery and LDAP users whose activity is detected by either user discovery or a User Agent.
 
    [bookmark: pgfId-1560753]User awareness allows all types of deployments to determine the “who” behind the “what.” For example, you could determine:
 
     
     	 [bookmark: pgfId-1560754]who is attempting unauthorized access of a server that has high host criticality
 
     	 [bookmark: pgfId-1560755]who is consuming an unreasonable amount of bandwidth
 
     	 [bookmark: pgfId-1560756]who has not applied critical operating system updates 
 
     	 [bookmark: pgfId-1560757]who is using instant messaging software or peer-to-peer file-sharing applications in violation of company IT policy
 
     	 [bookmark: pgfId-1560758]who owns the host targeted by an intrusion event that has a Vulnerable (level 1: red) impact level (requires Protection)
 
     	 [bookmark: pgfId-1560765]who initiated an internal attack or portscan (requires Protection)
 
    
 
    [bookmark: pgfId-1560766]Armed with this information, you can take a targeted approach to mitigate risk, and take action to protect others from disruption. User control adds the ability to block LDAP users and user activity. Together, user awareness and control capabilities significantly improve audit controls and enhance regulatory compliance. For more information, see Understanding User Data Collection.
 
    [bookmark: pgfId-1560770]The following table lists the requirements for user awareness and control. For detailed, up-to-date information on User Agents, see the User Agent Configuration Guide.
 
    [bookmark: pgfId-1560829]
 
     
      
       
       [bookmark: pgfId-1560776]Table 17-1 [bookmark: 22870]Requirements for User Awareness and Control 
 
       
       
        
        	 
          
          [bookmark: pgfId-1560782]Requirement 
         
  
        	 
          
          [bookmark: pgfId-1560784]User Awareness 
         
  
        	 
          
          [bookmark: pgfId-1560786]User Control 
         
  
       
 
        
        	[bookmark: pgfId-1560788]license
  
        	[bookmark: pgfId-1560793]FireSIGHT
  
        	[bookmark: pgfId-1560798]Control
  
       
 
        
        	[bookmark: pgfId-1560800]devices
  
        	[bookmark: pgfId-1560802]Any
  
        	[bookmark: pgfId-1560807]Any except Series 2 or X-Series
  
       
 
        
        	[bookmark: pgfId-1560812]Defense Centers
  
        	[bookmark: pgfId-1560814]Any
  
        	[bookmark: pgfId-1560816]Any except DC500
  
       
 
        
        	[bookmark: pgfId-1560818]User Agent
  
        	 [bookmark: pgfId-1560822]Install Version 2.2 of the User Agent on a Windows computer running one of the following, with TCP/IP access to and from the Defense Center and Microsoft Active Directory servers you want to monitor:
 
          
          	 [bookmark: pgfId-1587941]Windows Vista, Windows 7, or Windows 8
 
          	 [bookmark: pgfId-1587942]Windows Server 2008 or 2012 
 
         
 [bookmark: pgfId-1581408]You must also install Microsoft .NET Framework Version 4.0 Client Profile and Microsoft SQL Server Compact (SQL CE) Version 3.5.
  
       
 
        
        	[bookmark: pgfId-1560824]LDAP server for user metadata retrieval
  
        	 [bookmark: pgfId-1587937]One of the following, with TCP/IP access from the Defense Center:
 
          
          	 [bookmark: pgfId-1587938]Microsoft Active Directory on Windows Server 2008 (required for user control)
 
          	 [bookmark: pgfId-1587931]Oracle Directory Server Enterprise Edition 7.0 on Windows Server 2008 (user awareness only)
 
          	 [bookmark: pgfId-1561035]OpenLDAP on Linux (user awareness only)
 
         
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531472]For more information, see:
 
     
     	 [bookmark: pgfId-1560001]Adding a User Condition to an Access Control Rule
 
     	 [bookmark: pgfId-1531229]Retrieving Access-Controlled Users and LDAP User Metadata
 
     	 [bookmark: pgfId-1531259]Using User Agents to Report Active Directory Logins
 
    
 
   
 
    
     [bookmark: pgfId-1530844][bookmark: 14211]Adding a User Condition to an Access Co[bookmark: marker-1555334]ntrol Rule
 
    [bookmark: pgfId-1530879]License: Control
 
    [bookmark: pgfId-1536186]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-1555006]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1555010]The FireSIGHT System’s user control feature works by associating access-controlled users with host IP addresses. Deployed User Agents monitor specified users as they authenticate with Microsoft Active Directory credentials. For traffic to match an access control rule with a user condition, the IP address of either the source or destination host in the monitored session must be associated with a logged in access-controlled user.
 
    [bookmark: pgfId-1588793]Before you can perform user control, you must:
 
     
     	 [bookmark: pgfId-1588797]Configure a connection between the Defense Center and a Microsoft Active Directory server; see Retrieving Access-Controlled Users and LDAP User Metadata.
 
     	 [bookmark: pgfId-1561976]Install a User Agent on a Microsoft Windows computer with TCP/IP access to the Active Directory server; see Using User Agents to Report Active Directory Logins.
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1561980] 
     Caution If you configure a large number of user groups to monitor, or if you have a very large number of users mapped to hosts on your network, the system may drop user mappings based on groups, due to memory limitations. As a result, access control rules based on user groups may not fire as expected. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1561981]You can add a maximum of 50 users and groups to the Selected Users in a single user condition. Conditions with user groups match traffic to or from any of the group’s members, including members of any sub-groups, with the exception of individually excluded users and members of excluded sub-groups.
 
     
      
    
 
    
 
    [bookmark: pgfId-1587024]Note Before you can perform user control using a group criterion, the system must detect activity from at least one user in that group. This initial connection is not handled by the access control rule it matches, but instead by the next rule it matches, or the access control policy default action.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1587028]When building a user condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
    [bookmark: pgfId-1587029]To control user traffic:
 
    [bookmark: pgfId-1551901]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1551902]Step 1 In the access control policy that targets the devices where you want to control traffic by LDAP user or group, create a new access control rule or edit an existing rule.
 
    [bookmark: pgfId-1551906]For detailed instructions, see Creating and Editing Access Control Rules.
 
    [bookmark: pgfId-1551907]Step 2 In the rule editor, select the Users tab.
 
    [bookmark: pgfId-1551908]The Users tab appears.
 
    [bookmark: pgfId-1551914]Step 3 Find and select the users and groups you want to add from the Available Users list.
 
    [bookmark: pgfId-1551915]Users and groups are marked with different icons. To search for users and groups to add, click the Search by name or value prompt above the Available Users list, then type the name of the user or group. The list updates as you type to display matching items.
 
    [bookmark: pgfId-1554682]To select an item, click it. To select multiple item, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-1551919]Step 4 Click Add to Rule to add the selected users and groups to the Selected Users list. 
 
    [bookmark: pgfId-1551920]You can also drag and drop selected users and groups.
 
    [bookmark: pgfId-1551930]Step 5 Save or continue editing the rule.
 
    [bookmark: pgfId-1587464]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-1587466]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1587471][bookmark: 17006]Retrieving Access-Controlled Users and LDAP User Me[bookmark: marker-1587469]tad[bookmark: marker-1587470]ata
 
    [bookmark: pgfId-1578383]License: FireSIGHT or Control
 
    [bookmark: pgfId-1578387]Supported Devices: feature dependent
 
    [bookmark: pgfId-1578391]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1575922]Before you can perform user control (that is, write access control rules with user conditions), you must configure a connection between the Defense Center and at least one of your organization’s Microsoft Active Directory servers. The Defense Center regularly and automatically queries the LDAP server to update metadata for access-controlled users, that is, the users and groups whose activity you want to monitor with User Agents, and who you can use as criteria when limiting traffic. The Defense Center also retrieves metadata for non-access-controlled users whose activity has already been reported by a User Agent. Alternately, you can perform an on-demand query.
 
    [bookmark: pgfId-1576017]If you are not performing user control, you can query additional types of LDAP server for user awareness data—metadata associated with POP3 and IMAP users as well as LDAP users whose activity is detected by user discovery, rather than reported by an User Agent. The system uses the email addresses in POP3 and IMAP logins to correlate with LDAP users on an Active Directory, OpenLDAP, or Oracle Directory Server Enterprise Edition server. In this case, the Defense Center regularly queries the LDAP server to obtain new and updated metadata for users whose activity the system detected since the last query. 
 
    [bookmark: pgfId-1576000]For more information, see:
 
     
     	 [bookmark: pgfId-1536682]Connecting to an LDAP Server for User Awareness and Control
 
     	 [bookmark: pgfId-1562799]Updating User Control Parameters On-Demand
 
     	 [bookmark: pgfId-1577756]Pausing Communications with an LDAP Server
 
    
 
     
      [bookmark: pgfId-1530848][bookmark: 63774]Connecting to an LDAP Server for User Aware[bookmark: marker-1537064]ness and Control
 
     [bookmark: pgfId-1530954]License: FireSIGHT or Control
 
     [bookmark: pgfId-1572286]Supported Devices: feature dependent
 
     [bookmark: pgfId-1572786]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1579862]Connections between Defense Centers and your organization’s LDAP servers can:
 
      
      	 [bookmark: pgfId-1573395]specify the access-controlled users and groups whose activity you want to monitor with User Agents, and who you can use as criteria when limiting traffic with access control rules
 
      	 [bookmark: pgfId-1573507]allow you to query the server for metadata on access-controlled users, as well as some non-access-controlled users: POP3 and IMAP users detected by user discovery and LDAP users whose activity is detected by either user discovery or a User Agent.
 
     
 
     [bookmark: pgfId-1580104]These connections, or user awareness objects[bookmark: marker-1579912], specify connection settings and authentication filter settings for the LDAP server. They are similar to the authentication objects you configure to manage external authentication to the FireSIGHT System’s web interface; see Managing Authentication Objects.
 
     [bookmark: pgfId-1573576]To perform user control, you must connect to a Microsoft Active Directory LDAP server. If you simply want to retrieve LDAP user metadata, the system supports connections to other types of LDAP server; see Table 17-1.
 
     [bookmark: pgfId-1575609]When the system detects user activity, it can add a record of that user to the Defense Center users database, also called the user identity database. The Defense Center regularly queries the LDAP server to obtain metadata for new and updated users whose activity was detected since the last query. If a user already exists in the database, the system updates the metadata if it has not been updated in the last 12 hours. It may take several minutes for the Defense Center to update with user metadata after the system detects a new user login.
 
     [bookmark: pgfId-1576393]The system uses the email addresses in POP3 and IMAP logins to correlate with users on the LDAP server. For example, if a managed device detects a POP3 login for a user with the same email address as an LDAP user, the system associates the LDAP user’s metadata with that user.
 
      
       
     
 
     
 
     [bookmark: pgfId-1576718]Note If you remove a user that has been detected by the system from your LDAP servers, the Defense Center does not remove that user from its users database; you must manually delete it. However, your LDAP changes are reflected in access control rules when the Defense Center next updates its list of access-controlled users.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1574743]Table 17-2 Mapping LDAP Fields to Cisco Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-1574753]Metadata 
          
  
         	 
           
           [bookmark: pgfId-1574758]Defense Center 
          
  
         	 
           
           [bookmark: pgfId-1574760]Active Directory 
          
  
         	 
           
           [bookmark: pgfId-1574762]Oracle Directory Server 
          
  
         	 
           
           [bookmark: pgfId-1574764]OpenLDAP 
          
  
        
 
         
         	[bookmark: pgfId-1574766]LDAP user name
  
         	[bookmark: pgfId-1574768]Username
  
         	[bookmark: pgfId-1574770]samaccountname
  
         	[bookmark: pgfId-1574772]cn
 [bookmark: pgfId-1574773]uid
  
         	[bookmark: pgfId-1574775]cn
 [bookmark: pgfId-1574776]uid
  
        
 
         
         	[bookmark: pgfId-1574778]first name
  
         	[bookmark: pgfId-1574780]First Name
  
         	[bookmark: pgfId-1574782]givenname
  
         	[bookmark: pgfId-1574784]givenname
  
         	[bookmark: pgfId-1574786]givenname
  
        
 
         
         	[bookmark: pgfId-1574788]last name
  
         	[bookmark: pgfId-1574790]Last Name
  
         	[bookmark: pgfId-1574792]sn
  
         	[bookmark: pgfId-1574794]sn
  
         	[bookmark: pgfId-1574796]sn
  
        
 
         
         	[bookmark: pgfId-1574798]email address
  
         	[bookmark: pgfId-1574800]Email
  
         	[bookmark: pgfId-1574802]mail
 [bookmark: pgfId-1574803]userprincipalname (if mail has no value)
  
         	[bookmark: pgfId-1574805]mail
  
         	[bookmark: pgfId-1574807]mail
  
        
 
         
         	[bookmark: pgfId-1574809]department
  
         	[bookmark: pgfId-1574811]Department
  
         	[bookmark: pgfId-1574813]department
 [bookmark: pgfId-1574814]distinguishedname (if department has no value)
  
         	[bookmark: pgfId-1574816]department
  
         	[bookmark: pgfId-1574818]ou
  
        
 
         
         	[bookmark: pgfId-1574820]telephone number
  
         	[bookmark: pgfId-1574822]Phone
  
         	[bookmark: pgfId-1574824]telephonenumber
  
         	[bookmark: pgfId-1574826]n/a
  
         	[bookmark: pgfId-1574828]telephonenumber
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1570033]Work closely with your LDAP administrators to ensure your LDAP servers are correctly configured and that you can connect to them, and to obtain the information you must provide when creating an LDAP connection.
 
     [bookmark: pgfId-1570034]Server Type, IP Address, and Port
 
     [bookmark: pgfId-1576861]You must specify the server type, IP address or hostname, and port for a primary, and optionally a backup, LDAP server. To perform user control, you must use a Microsoft Active Directory server.
 
     [bookmark: pgfId-1576862]LDAP-Specific Parameters
 
     [bookmark: pgfId-1533982]When the Defense Center searches the LDAP server to retrieve user information on the authentication server, it needs a starting point for that search. You can specify the namespace, or directory tree, to search by providing a base distinguished name, or base DN. Typically, the base DN has a basic structure indicating the company domain and operational unit. For example, the Security organization of the Example company might have a base DN of ou=security,dc=example,dc=com. Note that after you identify a primary server, you can automatically retrieve a list of available base DNs from the server and select the appropriate base DN.
 
     [bookmark: pgfId-1533983]You must supply user credentials for a user with appropriate rights to the user information you want to retrieve. Remember that the distinguished name for the user you specify must be unique to the directory information tree for the directory server.
 
     [bookmark: pgfId-1533984]You can also specify an encryption method for the LDAP connection. Note that if you are using a certificate to authenticate, the name of the LDAP server in the certificate must match the host name that you specified in the Defense Center web interface. For example, if you use 10.10.10.250 when configuring the LDAP connection but computer1.example.com in the certificate, the connection fails. 
 
     [bookmark: pgfId-1533988]Finally, you must specify the timeout period after which attempts to contact an unresponsive LDAP server roll over to the backup connection.
 
     [bookmark: pgfId-1533990]User and Group Acc[bookmark: marker-1533989]ess Control Parameters
 
     [bookmark: pgfId-1533991]To perform user control, specify the groups you want to use as criteria in access control rules. 
 
     [bookmark: pgfId-1533992]Including a group automatically includes all of that group’s members, including members of any sub-groups. However, if you want to use the sub-group in access control rules, you must explicitly include the sub-group. You can also exclude groups and individual users. Excluding a group excludes all the members of that group, even if the users are members of an included group.
 
     [bookmark: pgfId-1533994]The maximum number of users you can use in access control depends on your FireSIGHT license. When choosing which users and groups to include, make sure the total number of users is less than your FireSIGHT user license. If your access control parameters are too broad, the Defense Center obtains information on as many users as it can and reports the number of users it failed to retrieve in the task queue.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534001]Note If you do not specify any groups to include, the system retrieves user data for all the groups that match the LDAP parameters you provided. For performance reasons, Cisco recommends that you explicitly include only the groups that represent the users you want to use in access control. Note that you cannot include the Users or Domain Users groups.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1570662]You must also specify how often the Defense Center queries the LDAP server to obtain new users to use in access control.
 ). If the connection is enabled, your saved changes take effect when the Defense Center next queries the LDAP server. 
     
 
     [bookmark: pgfId-1565994]To create an LDAP connection for user awareness or user control:
 
     [bookmark: pgfId-1534010]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1534011]Step 1 Select Policies > Users.
 
     [bookmark: pgfId-1534012]The Users Policy page appears.
 
     [bookmark: pgfId-1534014]Step 2 [bookmark: 40739]Click Add LDAP Connection.
 
     [bookmark: pgfId-1534015]The Create User Awareness Authentication Object page appears.
 
     [bookmark: pgfId-1534016]Step 3 Type a Name and Description for the object.
 
     [bookmark: pgfId-1534018]Step 4 [bookmark: 63658]Select the LDAP Server Type. 
 
     [bookmark: pgfId-1534019]If you want to perform user control, you must use a Microsoft Active Directory server.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534026]Note User Agents cannot transmit Active Directory user names ending with the $ character to the Defense Center. You must remove the final $ character if you want to monitor these users.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534031]Step 5 [bookmark: 57929]Specify an IP Address or Host Name for a primary and, optionally, a backup LDAP server.
 
     [bookmark: pgfId-1534032]Step 6 Specify the Port that your LDAP servers use for authentication traffic.
 
     [bookmark: pgfId-1534033]Step 7 Specify the Base DN for the LDAP directory you want to access.
 
     [bookmark: pgfId-1534034]For example, to authenticate names in the Security organization at the Example company, type ou=security,dc=example,dc=com.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534035]Tip To fetch a list of all available domains, click Fetch DNs and select the appropriate base distinguished name from the drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534036]Step 8 Specify the distinguished User Name and Password that you want to use to validate access to the LDAP directory. Confirm the password.
 
     [bookmark: pgfId-1534038]For example, if you are connecting to an OpenLDAP server where user objects have a uid attribute and the object for the administrator in the Security division at our example company has a uid value of NetworkAdmin, you would type uid=NetworkAdmin,ou=security,dc=example,dc=com.
 
     [bookmark: pgfId-1534039]Step 9 Choose an Encryption method. If you are using encryption, you can add an SSL Certificate.
 
     [bookmark: pgfId-1534040]The host name in the certificate must match the host name of the LDAP server you specified in step 5.
 
     [bookmark: pgfId-1534044]Step 10 Specify the Timeout period (in seconds) timeout period after which attempts to contact an unresponsive primary LDAP server roll over to the backup connection.
 
     [bookmark: pgfId-1534045]Step 11 Optionally, before you specify user awareness settings for the object, test the connection by clicking Test.
 
     [bookmark: pgfId-1534046]Step 12 You have two options, depending on the type of LDAP server you selected in step 4:
 
      
       
       	 [bookmark: pgfId-1534050]If you are connecting to an Active Directory server, you can enable  User/Group Access Control Parameters to specify users to use in access control. Continue with the next step.
 
       	 [bookmark: pgfId-1534051]If you are connecting to any other kind of server, or do not want to perform user control, skip to step 17.
 
      
 
     
 
     [bookmark: pgfId-1534055]Step 13 Click Fetch Groups to populate the available groups list using the LDAP parameters you provided.
 
     [bookmark: pgfId-1534056]Step 14 Specify the users you want to use in access control by using the right and left arrow buttons to include and exclude groups.
 
     [bookmark: pgfId-1534057]Including a group automatically includes all of that group’s members, including members of any sub-groups. However, if you want to use the sub-group in access control rules, you must explicitly include the sub-group. Excluding a group excludes all the members of that group, even if the users are members of an included group.
 
     [bookmark: pgfId-1534058]Step 15 Specify any particular User Exclusions.
 
     [bookmark: pgfId-1534059]Excluding a user prevents you from writing an access control rule using that user as a condition. Separate multiple users with commas. You can also use an asterisk (*) as a wildcard character in this field. 
 
     [bookmark: pgfId-1534063]Step 16 Specify how often you want to query the LDAP server to obtain new user and group information. 
 
     [bookmark: pgfId-1534067]By default, the Defense Center queries the server once a day at midnight:
 
      
       
       	 [bookmark: pgfId-1534068]Use the  Start At drop-down list to specify when you want the query to occur.  0 represents midnight,  1 represents 1:00 AM, and so on.
 
       	 [bookmark: pgfId-1534069]Use the  Update Interval drop-down list to specify how often, in hours, you want to query the server.
 
      
 
     
 
     [bookmark: pgfId-1534071]Step 17 [bookmark: 62366]Click Save.
 
     [bookmark: pgfId-1534072]If you added or made changes to user and group access control parameters, confirm that you want to implement your changes. The object is saved and the Users Policy page appears again.
 
     [bookmark: pgfId-1534144]Step 18 Enable the connection by clicking the slider next to the connection you just created. 
 
     [bookmark: pgfId-1534145]If you are enabling the connection and your connection has user and group access control parameters, choose whether you want to immediately query the LDAP server to obtain user and group information. Note that if you do not immediately query the LDAP server, the query occurs at the scheduled time. You can monitor any query’s progress in the task queue (System > Monitoring > Task Status).
 
     [bookmark: pgfId-1542450]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1577252][bookmark: 89384]Updating User Control Parameters On-Demand
 
     [bookmark: pgfId-1577277]License: Control
 
     [bookmark: pgfId-1577284]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1577288]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1577260]If you change the user and group access control parameters in an LDAP connection, or if you change the users or groups on your LDAP server and want your changes to be immediately available for user control, you can force the Defense Center to perform an on-demand user data retrieval from the Active Directory server. 
 
     [bookmark: pgfId-1532134]The maximum number of users the Defense Center can retrieve from the server depends on your FireSIGHT license. If the access control parameters in your LDAP connection are too broad, the Defense Center obtains information on as many users as it can and reports the number of users it failed to retrieve in the task queue.
 
     [bookmark: pgfId-1532141]To perform an on-demand user data retrieval:
 
     [bookmark: pgfId-1532142]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1532143]Step 1 Select Policies > Users.
 
     [bookmark: pgfId-1532144]The Users Policy page appears.
 ). 
     
 
     [bookmark: pgfId-1577524]The query begins. You can monitor its progress in the task queue (System > Monitoring > Task Status).
 
     [bookmark: pgfId-1577525]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1577617][bookmark: 33650]Pausing Communications with an LDAP S[bookmark: marker-1577616]erver
 
     [bookmark: pgfId-1578447]License: FireSIGHT or Control
 
     [bookmark: pgfId-1578451]Supported Devices: feature dependent
 
     [bookmark: pgfId-1578455]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1577628]Only enabled LDAP connections allow the Defense Center to query LDAP servers. To stop queries, you can temporarily disable LDAP connections rather than deleting them. 
 
     [bookmark: pgfId-1578366]When you re-enable an LDAP connection used for access control, you can force the Defense Center to query the server immediately for updated user and group information, or you can wait until the first scheduled query occurs.
 
     [bookmark: pgfId-1577633]To disable or re-enable an LDAP connection:
 
     [bookmark: pgfId-1577637]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1577638]Step 1 Select Policies > Users.
 
     [bookmark: pgfId-1577639]The Users Policy page appears.
 
     [bookmark: pgfId-1577640]Step 2 Pause or re-enable the connection by clicking the slider next to the connection you just created. 
 
     [bookmark: pgfId-1577641]If you are re-enabling the connection and your connection has user and group access control parameters, choose whether you want to immediately query the LDAP server to obtain user and group information. If you do not immediately query the LDAP server, the query occurs at the scheduled time. You can monitor any query’s progress in the task queue (System > Monitoring > Task Status).
 
     [bookmark: pgfId-1577642]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1577529][bookmark: 81452]Using Us[bookmark: marker-1577527]er Agents to Report Active Directory Logins
 
    [bookmark: pgfId-1566850]License: FireSIGHT
 
    [bookmark: pgfId-1578981]User Agents deployed on Microsoft Windows computers can monitor Microsoft Active Directory servers, then notify the Defense Center when LDAP users in your organization log in and out of hosts, or authenticate with Active Directory credentials for other reasons. For example, your organization may use services or applications that rely on Active Directory for centralized authentication. 
 
    [bookmark: pgfId-1581091]This agent-reported information serves not only as a record of user activity in your organizations, but also as the basis of user control. For traffic to match an access control rule with a user condition, the IP address of either the source or destination host in the monitored session must be associated with a logged in access-controlled user. You can control traffic based on individual users or the groups those users belong to.
 
     
      
    
 
    
 
    [bookmark: pgfId-1583005]Note If you want to perform user control, you must install and use User Agents. However, User Agents only report user activity related to Active Directory authentications. User awareness allows you to view all agent-reported user activity, as well as additional activity detected in allowed network traffic by managed devices. The system uses the discovery feature to identify login attempts over various protocols: AIM, IMAP, LDAP, Oracle, POP3, SIP, FTP, HTTP, and MDNS. For more information, see Understanding User Data Collection.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1589465]To retrieve LDAP user authentication records with User Agents for either user awareness or control, first configure each Defense Center to allow connections from the agents. In a high availability deployment, enable agent communications on both the primary Defense Center and the secondary Defense Center. User Agents can connect to up to five Defense Centers at a time. After you enable User Agent communications on the Defense Center, you can install agents on Windows computers; see Table 17-1. 
 
    [bookmark: pgfId-1590360]Finally, configure User Agents to receive data from Microsoft Active Directory servers and report the information to Defense Centers. You can also configure agents to exclude specific user names and IP addresses from the reporting, and log status messages to a local event log or the Windows application log. The User Agent Status Monitor health module monitors agents connected to a Defense Center; see Configuring User Agent Status Monitoring.
 
    [bookmark: pgfId-1533567]To configure the Defense Center to connect to a User Agent:
 
    [bookmark: pgfId-1533568]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1533569]Step 1 Select Policies > Users.
 
    [bookmark: pgfId-1533570]The Users Policy page appears.
 
    [bookmark: pgfId-1533574]Step 2 Click Add User Agent.
 
    [bookmark: pgfId-1533575]The Add User Agent pop-up window appears.
 
    [bookmark: pgfId-1533576]Step 3 Type a Name for the agent.
 
    [bookmark: pgfId-1533577]Step 4 Type the Hostname or Address of the computer where you plan to install the agent. You must use an IPv4 address; you cannot configure the Defense Center to connect to a User Agent using an IPv6 address.
 
    [bookmark: pgfId-1533578]Step 5 Click Add User Agent. 
 ) and confirm that you want to delete it. 
    
 
    [bookmark: pgfId-1533593]Step 6 Install User Agent on the computer you specified. Configure it to receive data from Microsoft Active Directory servers and report the information to Defense Centers.
 
    [bookmark: pgfId-1590052]For detailed, up-to-date information, see the User Agent Configuration Guide.
 
    [bookmark: pgfId-1542489]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1530607][bookmark: 22198]Controlling Traffic Using Intrusion and File Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1567127]Intrusion and file policies work together as part of the FireSIGHT System, as the last line of defense before traffic is allowed to its destination:
 
     
     	 [bookmark: pgfId-1569812] Intrusion policies govern the system’s intrusion prevention capabilities; see Understanding Network Analysis and Intrusion Policies.
 
     	 [bookmark: pgfId-1569859] File policies govern the system’s network-based file control and advanced malware protection (AMP) capabilities; see Understanding and Creating File Policies.
 
    
 
    [bookmark: pgfId-1569909]Hardware-based fast-pathing, Security Intelligence-based traffic filtering (blacklisting), SSL inspection-based decisions, and traffic decoding and preprocessing occur before network traffic is examined for intrusions, prohibited files, and malware. Access control rules and the access control default action determine which traffic is inspected by intrusion and file policies. 
 
    [bookmark: pgfId-1572222]By associating an intrusion or file policy with an access control rule, you are telling the system that before it passes traffic that matches the access control rule’s conditions, you first want to inspect the traffic with an intrusion policy, a file policy, or both.
 
     
      
    
 
    
 
    [bookmark: pgfId-1609179]Note By default, the system disables intrusion and file inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured. For more information, see Understanding Traffic Decryption and Using the SSL Preprocessor.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1590761]Table 18-1 License and Model Requirements for Intrusion and File Inspection 
 
       
       
        
        	 
          
          [bookmark: pgfId-1590771]Feature 
         
  
        	 
          
          [bookmark: pgfId-1590773]Description 
         
  
        	 
          
          [bookmark: pgfId-1590775]License 
         
  
        	 
          
          [bookmark: pgfId-1590780]Supported Defense Centers 
         
  
        	 
          
          [bookmark: pgfId-1590782]Supported Devices 
         
  
       
 
        
        	[bookmark: pgfId-1590784]intrusion prevention
  
        	[bookmark: pgfId-1590786]detect and optionally block intrusions and exploits
  
        	[bookmark: pgfId-1590791]Protection
  
        	[bookmark: pgfId-1590793]Any
  
        	[bookmark: pgfId-1590795]Any
  
       
 
        
        	[bookmark: pgfId-1590797]file control
  
        	[bookmark: pgfId-1590799]detect and optionally block the transmission of file types 
  
        	[bookmark: pgfId-1590804]Protection
  
        	[bookmark: pgfId-1590806]Any
  
        	[bookmark: pgfId-1590808]Any
  
       
 
        
        	[bookmark: pgfId-1590810]advanced malware protection (AMP)
  
        	[bookmark: pgfId-1590812]detect, store, track, and optionally block the transmission of malware
 [bookmark: pgfId-1590816]submit captured files to the Cisco cloud to analyze for malware
  
        	[bookmark: pgfId-1590821]Malware
  
        	[bookmark: pgfId-1590826]Any except DC500
  
        	[bookmark: pgfId-1590831]Any except Series 2 or X-Series
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1568953]If your organization has a FireAMP subscription, the Defense Center can also receive endpoint-based malware detection data from the Cisco cloud. The Defense Center presents this data alongside any network-based file and malware data generated by the system. Importing FireAMP data does not require a license in addition to your FireAMP subscription. For more information, see Working with Cloud Connections for FireAMP.
 
    [bookmark: pgfId-1568769]For more information on inspecting traffic for intrusions, prohibited files, and malware, see: 
 
     
     	 [bookmark: pgfId-1531267]Inspecting Allowed Traffic For Intrusions and Malware
 
     	 [bookmark: pgfId-1531297]Tuning Intrusion Prevention Performance
 
     	 [bookmark: pgfId-1531357]Tuning File and Malware Inspection Performance and Storage
 
    
 
   
 
    
     [bookmark: pgfId-1590132][bookmark: 61352]Inspecting Allowed Traffic For Intrusions and Malware
 
    [bookmark: pgfId-1590142]License: Protection or Malware
 
    [bookmark: pgfId-1590146]Supported Devices: feature dependent
 
    [bookmark: pgfId-1590150]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1608553]Intrusion and file policies govern the system’s intrusion prevention, file control, and AMP capabilities as a last line of defense before traffic is allowed to its destination. Hardware-based fast-path rules, Security Intelligence-based traffic filtering, SSL inspection decisions (including decryption), decoding and preprocessing, and access control rule selection occur before intrusion and file inspection.
 
    [bookmark: pgfId-1609073]Access control rules provide a granular method of handling network traffic across multiple managed devices. By associating an intrusion or file policy with an access control rule, you are telling the system that before it passes traffic that matches the access control rule’s conditions, you first want to inspect the traffic with an intrusion policy, a file policy, or both. Access control rule conditions can be simple or complex; you can control traffic by security zone, network or geographical location, VLAN, port, application, requested URL, and user.
 
    [bookmark: pgfId-1606115]The system matches traffic to access control rules in the order you specify. In most cases, the system handles network traffic according to the first access control rule where all the rule’s conditions match the traffic. An access control rule’s action determines how the system handles matching traffic. You can monitor, trust, block, or allow (with or without further inspection) matching traffic; see Using Rule Actions to Determine Traffic Handling and Inspection.
 
    [bookmark: pgfId-1603541]The following diagram shows the flow of traffic in an inline intrusion prevention and AMP deployment, as governed by an access control policy that contains four different types of access control rules and a default action.
 
    [bookmark: pgfId-1623385]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1577239]In the scenario above, the first three access control rules in the policy—Monitor, Trust, and Block—cannot inspect matching traffic. Monitor rules track and log but do not inspect network traffic, so the system continues to match traffic against additional rules to determine whether to permit or deny it. Trust and Block rules handle matching traffic without further inspection of any kind, while traffic that does not match continues to the next access control rule.
 
    [bookmark: pgfId-1576533]The fourth and final rule in the policy, an Allow rule, invokes various other policies to inspect and handle matching traffic, in the following order:
 
     
     	 [bookmark: pgfId-1576534] Discovery: Network Discovery Policy— First, the network discovery policy inspects traffic for discovery data. Discovery is passive analysis and does not affect the flow of traffic. Although you do not explicitly enable discovery, you can enhance or disable it. However, allowing traffic does not automatically guarantee discovery data collection. The system performs discovery only for connections involving IP addresses that are explicitly monitored by your network discovery policy. For more information, see  Introduction to Network Discovery.
 
     	 [bookmark: pgfId-1576538] Advanced Malware Protection and File Control: File Policy— After traffic is inspected by discovery, the system can inspect it for prohibited files and malware. Network-based AMP detects and optionally blocks malware in many types of files, including PDFs, Microsoft Office documents, and others. If your organization wants to block not only the transmission of malware files, but all files of a specific type (regardless of whether the files contain malware),  file control allows you to monitor network traffic for transmissions of specific file types, then either block or allow the file. 
 
     	 [bookmark: pgfId-1576542] Intrusion Prevention: Intrusion Policy— After file inspection, the system can inspect traffic for intrusions and exploits. An intrusion policy examines decoded packets for attacks based on patterns, and can  block or alter malicious traffic . Intrusion policies are paired with  variable sets , which allow you to use named values to accurately reflect your network environment.
 
     	 [bookmark: pgfId-1576546] Destination— Traffic that passes all the checks described above passes to its destination.
 
    
 
    [bookmark: pgfId-1576547]Note that an Interactive Block rule (not shown in the diagram) has the same inspection options as an Allow rule. This is so you can inspect traffic for malicious content when a user bypasses a blocked website by clicking through a warning page. For more information, see Interactive Blocking Actions: Allowing Users to Bypass Website Blocks.
 
    [bookmark: pgfId-1576812]Traffic that does not match any of the non-Monitor access control rules in the policy is handled by the default action. In this scenario, the default action is an Intrusion Prevention action, which allows traffic to its final destination as long as it is passed by the intrusion policy you specify. In a different deployment, you might have a default action that trusts or blocks all traffic without further inspection; see Table 12-4. Note that the system can inspect traffic allowed by the default action for discovery data and intrusions, but not prohibited files or malware. You cannot associate a file policy with the access control default action.
 
     
      
    
 
    
 
    [bookmark: pgfId-1605716]Note Sometimes, when a connection is analyzed by an access control policy, the system must process the first few packets in that connection, allowing them to pass, before it can decide which access control rule (if any) will handle the traffic. However, so these packets do not reach their destination uninspected, you can use an intrusion policy—called the default intrusion policy—to inspect them and generate intrusion events. For more information, see Setting the Default Intrusion Policy for Access Control.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1605720]For more information on the above scenario and instructions on associating file and intrusion policies with access control rules and the access control default action, see:
 
     
     	 [bookmark: pgfId-1566930]Understanding File and Intrusion Inspection Order
 
     	 [bookmark: pgfId-1590923]Configuring an Access Control Rule to Perform AMP or File Control
 
     	 [bookmark: pgfId-1575146]Configuring an Access Control Rule to Perform Intrusion Prevention
 
     	 [bookmark: pgfId-1577222]Setting Default Handling and Inspection for Network Traffic
 
    
 
     
      [bookmark: pgfId-1577224][bookmark: 44943]Understanding File and Intrusion Inspection Order
 
     [bookmark: pgfId-1577439]License: Protection or Malware
 
     [bookmark: pgfId-1577443]Supported Devices: feature dependent
 
     [bookmark: pgfId-1577447]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1565306]The scenario in Inspecting Allowed Traffic For Intrusions and Malware shows one access control rule of each type, including an Allow rule associated with both a file policy and intrusion policy. In your access control policy, you can associate multiple Allow and Interactive Block rules with different intrusion and file policies to match inspection profiles to various types of traffic.
 
      
       
     
 
     
 
     [bookmark: pgfId-1577355]Note Traffic allowed by an Intrusion Prevention or Network Discovery Only default action can be inspected for discovery data and intrusions, but cannot be inspected for prohibited files or malware. You cannot associate a file policy with the access control default action.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1565445]You do not have to perform both file and intrusion inspection in the same rule. For a connection matching an Allow or Interactive Block rule:
 
      
      	 [bookmark: pgfId-1565307]without a file policy, traffic flow is determined by the intrusion policy
 
      	 [bookmark: pgfId-1565308]without an intrusion policy, traffic flow is determined by the file policy
 
      	 [bookmark: pgfId-1565309]without either, allowed traffic is inspected by network discovery only
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1582134]Tip The system does not perform any kind of inspection on trusted traffic. Although configuring an Allow rule with neither an intrusion nor file policy passes traffic like a Trust rule, Allow rules let you perform discovery on matching traffic.
 
      
      
 
     
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1564602]For any single connection handled by an access control rule, file inspection occurs before intrusion inspection. That is, the system does not inspect files blocked by a file policy for intrusions. Within file inspection, simple blocking by type takes precedence over malware inspection and blocking.
 
     [bookmark: pgfId-1562274]For example, consider a scenario where you normally want to allow certain network traffic as defined in an access control rule. However, as a precaution, you want to block the download of executable files, examine downloaded PDFs for malware and block any instances you find, and perform intrusion inspection on the traffic. 
 
     [bookmark: pgfId-1565084]You create an access control policy with a rule that matches the characteristics of the traffic you want to provisionally allow, and associate it with both an intrusion policy and a file policy. The file policy blocks the download of all executables, and also inspects and blocks PDFs containing malware:
 
      
      	 [bookmark: pgfId-1562275]First, the system blocks the download of all executables, based on simple type matching specified in the file policy. Because they are immediately blocked, these files are subject to neither malware cloud lookup nor intrusion inspection.
 
      	 [bookmark: pgfId-1562276]Next, the system performs malware cloud lookups for PDFs downloaded to a host on your network. Any PDFs with a malware file disposition are blocked, and are not subject to intrusion inspection.
 
      	 [bookmark: pgfId-1577021]Finally, the system uses the intrusion policy associated with the access control rule to inspect any remaining traffic, including files not blocked by the file policy.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1612234]Note Until a file is detected and blocked in a session packets from the session may be subject to intrusion inspection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1578596][bookmark: 48642]Configuring an Access Control Rule to Perform AMP or File Control
 
     [bookmark: pgfId-1578606]License: Protection or Malware
 
     [bookmark: pgfId-1578610]Supported Devices: feature dependent
 
     [bookmark: pgfId-1578614]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1579107]An access control policy can have multiple access control rules associated with file policies. You can configure file inspection for any Allow or Interactive Block access control rule, which permits you to match different file and malware inspection profiles against different types of traffic on your network before it reaches its final destination.
 
     [bookmark: pgfId-1580004]When the system detects a prohibited file (including malware) according to the settings in the file policy, it automatically logs an event to the Defense Center database. If you do not want to log file or malware events, you can disable this logging on a per-access-control-rule basis. After you associate the file policy with the access control rule, clear the Log Files check box on the Logging tab of the access control rule editor. For more information, see Disabling File and Malware Event Logging for Allowed Connections.
 
     [bookmark: pgfId-1579963]The system also logs the end of the associated connection to the Defense Center database, regardless of the logging configuration of the invoking access control rule; see Connections Associated with File and Malware Events (Automatic).
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1617818] 
      Caution Associating a file policy with an access control rule, or subsequently dissociating the policy by selecting 
      None, restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1578623]To associate a file policy with an access control rule:
 
     [bookmark: pgfId-1589014]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1589015]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1589016]The Access Control Policy page appears.
 ) next to the access control policy where you want to configure AMP or file control using access control rules. 
     
 
     [bookmark: pgfId-1578637]Step 3 Create a new rule or edit an existing rule; see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1578638]The access control rule editor appears.
 
     [bookmark: pgfId-1578639]Step 4 Ensure the rule action is set to Allow, Interactive Block, or Interactive Block with reset.
 
     [bookmark: pgfId-1578640]Step 5 Select the Inspection tab.
 
     [bookmark: pgfId-1578641]The Inspection tab appears.
 
     [bookmark: pgfId-1578642]Step 6 Select a File Policy to inspect traffic that matches the access control rule, or select None to disable file inspection for matching traffic.
 ) that appears to edit the policy in a new browser tab; see 
     Creating a File Policy. 
     
 
     [bookmark: pgfId-1590998]Step 7 Click Add to save the rule.
 
     [bookmark: pgfId-1591001]Your rule is saved. You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1578652]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1577023][bookmark: 22055]Configuring an Access Control Rule to Perform Intrusion Prevention
 
     [bookmark: pgfId-1580571]License: Protection
 
     [bookmark: pgfId-1580613]An access control policy can have multiple access control rules associated with intrusion policies. You can configure intrusion inspection for any Allow or Interactive Block access control rule, which permits you to match different intrusion inspection profiles against different types of traffic on your network before it reaches its final destination.
 
     [bookmark: pgfId-1591580]Whenever the system uses an intrusion policy to evaluate traffic, it uses an associated variable set. Variables in a set represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions and dynamic rule states.
 
      
       
     
 
     
 
     [bookmark: pgfId-1591584]Tip Even if you use system-provided intrusion policies, Cisco strongly recommends you configure the system’s intrusion variables to accurately reflect your network environment. At a minimum, modify default variables in the default set; see Optimizing Predefined Default Variables.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1606089]The number of unique intrusion policies you can use in a single access control policy depends on the model of the target devices; more powerful devices can handle more. Every unique pair of intrusion policy and variable set counts as one policy. Although you can associate a different intrusion policy-variable set pair with each Allow and Interactive Block rule (as well as with the default action), you cannot apply an access control policy if the target devices have insufficient resources to perform inspection as configured. For more information, see Simplifying Rules to Improve Performance.
 
     [bookmark: pgfId-1591093]Understanding System-Provided and Custom Intrusion Policies
 
     [bookmark: pgfId-1582635]Cisco delivers several intrusion policies with the FireSIGHT System. By using system-provided intrusion policies, you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states, as well as provides the initial configurations for advanced settings. You can use system-provided policies as-is, or you can use them as the base for custom policies. Building custom policies can improve the performance of the system in your environment and provide a focused view of the malicious traffic and policy violations occurring on your network. 
 
     [bookmark: pgfId-1583322]In addition to custom policies that you create, the system provides two custom policies: Initial Inline Policy and Initial Passive Policy. These two intrusion policies use the Balanced Security and Connectivity intrusion policy as their base. The only difference between them is their Drop When Inline setting, which enables drop behavior in the inline policy and disables it in the passive policy. For more information, see Comparing System-Provided with Custom Policies.
 
     [bookmark: pgfId-1586123]Connection and Intrusion Event Logging
 
     [bookmark: pgfId-1618098]When an intrusion policy invoked by an access control rule detects an intrusion and generates an intrusion event, it saves that event to the Defense Center database. The system also automatically logs the end of the connection where the intrusion occurred to the Defense Center database, regardless of the logging configuration of the access control rule; see Connections Associated with Intrusions (Automatic).
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1618499] 
      Caution Associating an intrusion policy with an access control rule, or subsequently dissociating the policy by selecting 
      None, restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1618108]To associate an intrusion policy with an access control rule:
 
     [bookmark: pgfId-1618112]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1574907]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1574908]The Access Control Policy page appears.
 ) next to the access control policy where you want to configure intrusion inspection using access control rules. 
     
 
     [bookmark: pgfId-1574916]Step 3 Create a new rule or edit an existing rule; see Creating and Editing Access Control Rules.
 
     [bookmark: pgfId-1574917]The access control rule editor appears.
 
     [bookmark: pgfId-1574918]Step 4 Ensure the rule action is set to Allow, Interactive Block, or Interactive Block with reset.
 
     [bookmark: pgfId-1574919]Step 5 Select the Inspection tab.
 
     [bookmark: pgfId-1574920]The Inspection tab appears.
 
     [bookmark: pgfId-1574921]Step 6 Select a system-provided or custom Intrusion Policy, or select None to disable intrusion inspection for traffic that matches the access control rule.
 ) that appears to edit the policy in a new browser tab; see 
     Editing Intrusion Policies. 
     
 
     [bookmark: pgfId-1574933]Step 7 Optionally, change the Variable Set associated with the intrusion policy. 
 ) that appears to edit the variable set in a new browser tab; see 
     Working with Variable Sets. 
     
 
     [bookmark: pgfId-1574941]Step 8 Click Save to save the rule.
 
     [bookmark: pgfId-1574944]Your rule is saved. You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1574946]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1543562][bookmark: 18731][bookmark: 50313]Tuning Intrusion Prevention Performance
 
    [bookmark: pgfId-1543569]License: Protection
 
    [bookmark: pgfId-1537444]Cisco provides several features for improving the performance of your system as it analyzes traffic for attempted intrusions. You configure these performance settings on a per-access-control-policy basis, and they apply to all intrusion policies invoked by that parent access control policy.
 
    [bookmark: pgfId-1540817]For more information, see:
 
     
     	 [bookmark: pgfId-1536999]Limiting Pattern Matching for Intrusions describes how you can specify the number of packets to allow in the event queue, and enable or disable inspection of packets that will be rebuilt into larger streams.
 
     	 [bookmark: pgfId-1537571]Overriding Regular Expression Limits for Intrusion Rules describes how you can override default match and recursion limits on Perl-compatible regular expressions (PCRE).
 
     	 [bookmark: pgfId-1537581]Limiting Intrusion Events Generated Per Packet describes how you can configure rule processing event queue settings.
 
     	 [bookmark: pgfId-1537595]Configuring Packet and Intrusion Rule Latency Thresholds describes settings for packet and rule latency thresholding.
 
     	 [bookmark: pgfId-1537599]Configuring Intrusion Performance Statistic Logging describes how you can configure your managed devices’ basic performance monitoring and reporting parameters.
 
    
 
     
      [bookmark: pgfId-1530914][bookmark: 58015]Limiting Pattern Matching for Intru[bookmark: marker-1537547]sions
 
     [bookmark: pgfId-1537462]License: Protection
 
     [bookmark: pgfId-1537463]You can specify the number of packets to allow in the event queue. You can also, before and after stream reassembly, enable or disable inspection of packets that will be rebuilt into larger streams.
 
     [bookmark: pgfId-1537465]To configure event queue settings:
 
     [bookmark: pgfId-1540137]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1540138]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1540139]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1540144]The access control policy editor appears.
 
     [bookmark: pgfId-1540145]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1540146]The access control policy advanced settings page appears.
 tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1537492]Step 5 You can modify the following options:
 
      
       
       	 [bookmark: pgfId-1537494]Type a value for the maximum number of events to queue in the  Maximum Pattern States to Analyze Per Packet  field.
 
       	 [bookmark: pgfId-1537495]To inspect packets which will be rebuilt into larger streams of data before and after stream reassembly, select  Disable Content Checks on Traffic Subject to Future Reassembly . Inspection before and after reassembly requires more processing overhead and may decrease performance.
 
       	 [bookmark: pgfId-1537496]To disable inspection of packets which will be rebuilt into larger streams of data before and after stream reassembly, clear  Disable Content Checks on Traffic Subject to Future Reassembly . Disabling inspection decreases the processing overhead for inspection of stream inserts and may boost performance.
 
      
 
     
 
     [bookmark: pgfId-1540260]Step 6 Click OK.
 
     [bookmark: pgfId-1540263]You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1540265]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1530915][bookmark: 10526]Overriding Regular Expression Limits for Int[bookmark: marker-1539859]rusion Rules
 
     [bookmark: pgfId-1537648]License: Protection
 
     [bookmark: pgfId-1537649]You can override default match and recursion limits on PCRE that are used in intrusion rules to examine packet payload content. See Searching for Content Using PCRE for information on using the pcre keyword in intrusion rules. The default limits ensure a minimum level of performance. Overriding these limits could increase security, but could also significantly impact performance by permitting packet evaluation against inefficient regular expressions.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1537653] 
      Caution Do not override default PCRE limits unless you are an experienced intrusion rule writer with knowledge of the impact of degenerative patterns. 
       
       
 
      
 
     
 
      
       
        
        [bookmark: pgfId-1539755]Table 18-2 [bookmark: 90281]Regular Expression Constraint Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1539759]Option 
          
  
         	 
           
           [bookmark: pgfId-1539761]Description 
          
  
        
 
         
         	[bookmark: pgfId-1539763]Match Limit State
  
         	[bookmark: pgfId-1539765]Specifies whether to override Match Limit. You have the following options:
 
           
           	 [bookmark: pgfId-1539766]select  Default to use the value configured for  Match Limit 
 
           	 [bookmark: pgfId-1539767]select  Unlimited to permit an unlimited number of attempts
 
           	 [bookmark: pgfId-1539768]select  Custom to specify either a limit of 1 or greater for  Match Limit , or to specify 0 to completely disable PCRE match evaluations
 
          
  
        
 
         
         	[bookmark: pgfId-1539770]Match Limit
  
         	[bookmark: pgfId-1539772]Specifies the number of times to attempt to match a pattern defined in a PCRE regular expression.
  
        
 
         
         	[bookmark: pgfId-1539774]Match Recursion Limit State
  
         	[bookmark: pgfId-1539776]Specifies whether to override Match Recursion Limit. You have the following options:
 
           
           	 [bookmark: pgfId-1539777]select  Default to use the value configured for  Match Recursion Limit 
 
           	 [bookmark: pgfId-1539778]select  Unlimited to permit an unlimited number of recursions
 
           	 [bookmark: pgfId-1539779]select  Custom to specify either a limit of 1 or greater for  Match Recursion Limit , or to specify 0 to completely disable PCRE recursions
 
          
 [bookmark: pgfId-1539780]Note that for Match Recursion Limit to be meaningful, it must be smaller than Match Limit.
  
        
 
         
         	[bookmark: pgfId-1539782]Match Recursion Limit
  
         	[bookmark: pgfId-1539784]Specifies the number of recursions when evaluating a PCRE regular expression against the packet payload. 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1537696]To configure PCRE overrides:
 
     [bookmark: pgfId-1540301]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1540302]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1540303]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1540308]The access control policy editor appears.
 
     [bookmark: pgfId-1540309]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1540310]The access control policy advanced settings page appears.
 , then select the Regular Expression Limits tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1537726]Step 5 You can modify any of the options in the Regular Expression Constraint Options table.
 
     [bookmark: pgfId-1540850]Step 6 Click OK.
 
     [bookmark: pgfId-1540872]You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1540874]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1540877][bookmark: 86305]Limiting Intrusion Events Genera[bookmark: marker-1540876]ted Per Packet
 
     [bookmark: pgfId-1537801]License: Protection
 
     [bookmark: pgfId-1537802]When the rules engine evaluates traffic against rules, it places the events generated for a given packet or packet stream in an event queue, then reports the top events in the queue to the user interface. You can elect to have the rules engine log more than one event per packet or packet stream when multiple events are generated. Logging these events allows you to collect information beyond the reported event. When configuring this option, you can specify how many events can be placed in the queue and how many are logged, and select the criteria for determining event order within the queue.
 
      
       
        
        [bookmark: pgfId-1588412]Table 18-3 [bookmark: 55074]Intrusion Event Logging Limits Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1588416]Option 
          
  
         	 
           
           [bookmark: pgfId-1588418]Description 
          
  
        
 
         
         	[bookmark: pgfId-1588420]Maximum Events Stored Per Packet
  
         	[bookmark: pgfId-1588422]The maximum number of events that can be stored for a given packet or packet stream.
  
        
 
         
         	[bookmark: pgfId-1588424]Maximum Events Logged Per Packet
  
         	[bookmark: pgfId-1588426]The number of events logged for a given packet or packet stream. This cannot exceed the Maximum Events Stored Per Packet value.
  
        
 
         
         	[bookmark: pgfId-1588428]Prioritize Event Logging By
  
         	[bookmark: pgfId-1588430]The value used to determine event ordering within the event queue. The highest ordered event is reported through the user interface. You can select from:
 
           
           	 [bookmark: pgfId-1588431] priority , which orders events in the queue by the event priority.
 
           	 [bookmark: pgfId-1588432] content_length , which orders events by the longest identified content match. When events are ordered by content length, rule events always take precedence over decoder and preprocessor events.
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1588434]To configure how many events are logged per packet or stream:
 
     [bookmark: pgfId-1540513]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1540514]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1540515]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1540520]The access control policy editor appears.
 
     [bookmark: pgfId-1540521]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1540522]The access control policy advanced settings page appears.
 tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1537858]Step 5 You can modify any of the options in the Intrusion Event Logging Limits Options table.
 
     [bookmark: pgfId-1542333]Step 6 Click OK.
 
     [bookmark: pgfId-1542336]You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1537867]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1530917][bookmark: 34550]Configuring Packet and Intrusion Rule Latency Thresholds
 
     [bookmark: pgfId-1539497]License: Protection
 
     [bookmark: pgfId-1538484]Settings for packet and rule latency thresholding maintain device latency. For more information, see:
 
      
      	 [bookmark: pgfId-1539382]Understanding Packet Latency Thresholding
 
      	 [bookmark: pgfId-1539403]Configuring Packet Latency Thresholding
 
      	 [bookmark: pgfId-1539447]To disable packet latency thresholding:
 
      	 [bookmark: pgfId-1539458]Configuring Rule Latency Thresholding
 
     
 
    
 
     
      [bookmark: pgfId-1537937][bookmark: 82847]Understanding Packet Latency Thres[bookmark: marker-1538516]holding
 
     [bookmark: pgfId-1537944]License: Protection
 
     [bookmark: pgfId-1537945]You can balance security with the need to maintain latency at an acceptable level by enabling packet latency thresholding. Packet latency thresholding measures the total elapsed time taken to process a packet by applicable decoders, preprocessors, and rules, and ceases inspection of the packet if the processing time exceeds a configurable threshold.
 
     [bookmark: pgfId-1537947]Packet latency thresholding measures elapsed time, not just processing time, in order to more accurately reflect the actual time required for the rule to process a packet. However, latency thresholding is a software-based latency implementation that does not enforce strict timing.
 
     [bookmark: pgfId-1537948]The trade-off for the performance and latency benefits derived from latency thresholding is that uninspected packets could contain attacks.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1577515]As illustrated in the above figure, packet latency timing is tested at the following test points:
 
      
      	 [bookmark: pgfId-1537959]after the completion of all decoder and preprocessor processing and before rule processing begins
 
      	 [bookmark: pgfId-1537960]after processing by each rule
 
     
 
     [bookmark: pgfId-1537961]If the processing time exceeds the threshold at any test point, packet inspection ceases.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537962]Tip Total packet processing time does not include routine TCP stream or IP fragment reassembly times.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537963]Packet latency thresholding has no effect on events triggered by a decoder, preprocessor, or rule processing the packet. Any applicable decoder, preprocessor, or rule triggers normally until a packet is fully processed, or until packet processing ends because the latency threshold is exceeded, whichever comes first. If a drop rule detects an intrusion in an inline deployment, the drop rule triggers an event and the packet is dropped.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537964]Note No packets are evaluated against rules after processing for that packet ceases because of a packet latency threshold violation. A rule that would have triggered an event cannot trigger that event, and for drop rules, cannot drop the packet.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537968]For more information on drop rules, see Setting Rule States.
 
     [bookmark: pgfId-1537969]Packet latency thresholding can improve system performance in both passive and inline deployments, and can reduce latency in inline deployments, by stopping inspection of packets that require excessive processing time. These performance benefits might occur when, for example:
 
      
      	 [bookmark: pgfId-1537970]for both passive and inline deployments, sequential inspection of a packet by multiple rules requires an excessive amount of time
 
      	 [bookmark: pgfId-1537971]for inline deployments, a period of poor network performance, such as when someone downloads an extremely large file, slows packet processing
 
     
 
     [bookmark: pgfId-1537972]In a passive deployment, stopping the processing of packets might not contribute to restoring network performance because processing simply moves to the next packet.
 
    
 
     
      [bookmark: pgfId-1538062][bookmark: 57665]Configuring Packet [bookmark: marker-1538061]Latency Thresh[bookmark: marker-1538539]olding
 
     [bookmark: pgfId-1612797]License: Protection
 
      
       
        
        [bookmark: pgfId-1625691]Table 18-4 [bookmark: 59012]Packet Latency Thresholding Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1625695]Option 
          
  
         	 
           
           [bookmark: pgfId-1625697]Description 
          
  
        
 
         
         	[bookmark: pgfId-1625699]Threshold (microseconds)
  
         	[bookmark: pgfId-1625701]Specifies the time, in microseconds, when inspection of a packet ceases. 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1626606]You can enable rule 134:3 to generate an event when the system stops inspecting a packet because the packet latency threshold is exceeded. See Setting Rule States for more information.
 
     [bookmark: pgfId-1540967]To configure packet latency thresholding:
 
     [bookmark: pgfId-1542968]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1541055]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1541056]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1541061]The access control policy editor appears.
 
     [bookmark: pgfId-1541062]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1541063]The access control policy advanced settings page appears.
 , then select the Packet Handling tab in the pop-up window that appears. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1614211]Tip By default, packet latency thresholding is enabled. To completely disable latency thresholding, clear the Enable checkbox.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1541015]Step 5 Click OK.
 
     [bookmark: pgfId-1613913]You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy. 
 
     [bookmark: pgfId-1613915]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1612967][bookmark: 98214]To disable packet latency thresholding:
 
     [bookmark: pgfId-1613071]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1613072]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1613073]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1613078]The access control policy editor appears.
 
     [bookmark: pgfId-1613079]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1613080]The access control policy advanced settings page appears.
 , then select the Packet Handling tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1613091]Step 5 Click OK.
 
     [bookmark: pgfId-1613094]You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1613096]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1612970]Understanding Rule Lat[bookmark: marker-1612968]ency Threshold[bookmark: marker-1612969]ing
 
     [bookmark: pgfId-1538119]License: Protection
 
     [bookmark: pgfId-1538120]Rule latency thresholding measures the elapsed time each rule takes to process an individual packet, suspends the violating rule along with a group of related rules for a specified time if the processing time exceeds the rule latency threshold a configurable consecutive number of times, and restores the rules when the suspension expires.
 
     [bookmark: pgfId-1538122]Rule latency thresholding measures elapsed time, not just processing time, in order to more accurately reflect the actual time required for the rule to process a packet. However, latency thresholding is a software-based latency implementation that does not enforce strict timing.
 
     [bookmark: pgfId-1538123]The trade-off for the performance and latency benefits derived from latency thresholding is that uninspected packets could contain attacks.
 
     [bookmark: pgfId-1538124]A timer measures the processing time each time a packet is processed against a group of rules. Any time the rule processing time exceeds a specified rule latency threshold, the system increments a counter. If the number of consecutive threshold violations reaches a specified number, the system takes the following actions:
 
      
      	 [bookmark: pgfId-1538125]suspends the rules for the specified period
 
      	 [bookmark: pgfId-1538126]triggers an event indicating the rules have been suspended
 
      	 [bookmark: pgfId-1538127]re-enables the rules when the suspension expires
 
      	 [bookmark: pgfId-1538128]triggers an event indicating the rules have been re-enabled
 
     
 
     [bookmark: pgfId-1538129]The system zeroes the counter when the group of rules has been suspended, or when rule violations are not consecutive. Permitting some consecutive violations before suspending rules lets you ignore occasional rule violations that might have negligible impact on performance and focus instead on the more significant impact of rules that repeatedly exceed the rule latency threshold.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1601837]In the above example, the time required to process each of the first three packets violates the rule latency threshold of 1000 microseconds, and the violations counter increments with each violation. Processing of the fourth packet does not violate the threshold, and the violations counter resets to zero. The fifth packet violates the threshold and the violations counter restarts at one.
 
     [bookmark: pgfId-1601838]The following example shows five consecutive rule processing times that do result in rule suspension.
 
     [bookmark: pgfId-1623495]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1538149]In the second example, the time required to process each of the five packets violates the rule latency threshold of 1000 microseconds. The group of rules is suspended because the rule processing time of 1100 microseconds for each packet violates the threshold of 1000 microseconds for the specified five consecutive violations. Any subsequent packets, represented in the figure as packets 6 through n, are not examined against suspended rules until the suspension expires. If more packets occur after the rules are re-enabled, the violations counter begins again at zero.
 
     [bookmark: pgfId-1538150]Rule latency thresholding has no effect on intrusion events triggered by the rules processing the packet. A rule triggers an event for any intrusion detected in the packet, regardless of whether the rule processing time exceeds the threshold. If the rule detecting the intrusion is a drop rule in an inline deployment, the packet is dropped. When a drop rule detects an intrusion in a packet that results in the rule being suspended, the drop rule triggers an intrusion event, the packet is dropped, and that rule and all related rules are suspended. For more information on drop rules, see Setting Rule States.
 
      
       
     
 
     
 
     [bookmark: pgfId-1538154]Note Packets are not evaluated against suspended rules. A suspended rule that would have triggered an event cannot trigger that event and, for drop rules, cannot drop the packet.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1538155]Rule latency thresholding can improve system performance in both passive and inline deployments, and can reduce latency in inline deployments, by suspending rules that take the most time to process packets. Packets are not evaluated again against suspended rules until a configurable time expires, giving the overloaded device time to recover. These performance benefits might occur when, for example:
 
      
      	 [bookmark: pgfId-1538156]hastily written, largely untested rules require an excessive amount of processing time
 
      	 [bookmark: pgfId-1538157]a period of poor network performance, such as when someone downloads an extremely large file, causes slow packet inspection
 
     
 
    
 
     
      [bookmark: pgfId-1538251][bookmark: 38502]Configuring Rule Latency Thres[bookmark: marker-1538250]holding
 
     [bookmark: pgfId-1538259]License: Protection
 
     [bookmark: pgfId-1539151]Rule latency thresholding suspends rules for the time specified by Suspension Time when the time rules take to process a packet exceeds Threshold for the consecutive number of times specified by Consecutive Threshold Violations Before Suspending Rule. 
 
     [bookmark: pgfId-1539152]You can enable rule 134:1 to generate an event when rules are suspended, and rule 134:2 to generate an event when suspended rules are enabled. See Viewing Intrusion Events and Setting Rule States for more information.
 
      
       
        
        [bookmark: pgfId-1539166]Table 18-5 [bookmark: 71567]Rule Latency Thresholding Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1539170]Option 
          
  
         	 
           
           [bookmark: pgfId-1539172]Description 
          
  
        
 
         
         	[bookmark: pgfId-1539174]Threshold
  
         	[bookmark: pgfId-1539176]Specifies the time in microseconds that rules should not exceed when examining a packet. 
  
        
 
         
         	[bookmark: pgfId-1539181]Consecutive Threshold Violations Before Suspending Rule
  
         	[bookmark: pgfId-1539183]Specifies the consecutive number of times rules can take longer than the time set for Threshold to inspect packets before rules are suspended.
  
        
 
         
         	[bookmark: pgfId-1539185]Suspension Time
  
         	[bookmark: pgfId-1539187]Specifies the number of seconds to suspend a group of rules.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1538261]To configure rule latency thresholding:
 
     [bookmark: pgfId-1542992]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1541117]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1541118]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1541123]The access control policy editor appears.
 
     [bookmark: pgfId-1541124]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1541125]The access control policy advanced settings page appears.
 , then select the Rule Handling tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1538290]Step 5 You can configure any of the options in the Rule Latency Thresholding Options table. 
 
     [bookmark: pgfId-1541033]Step 6 Click OK.
 
     [bookmark: pgfId-1541036]You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1538297]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1530918][bookmark: 27608]Configuring Intrusion Performance Statistic Log[bookmark: marker-1535455]ging
 
     [bookmark: pgfId-1535356]License: Protection
 
     [bookmark: pgfId-1535357]You can configure the basic parameters of how devices monitor and report their own performance. This allows you to specify the intervals at which the system updates performance statistics on your devices by configuring the following options.
 
     [bookmark: pgfId-1535585]Sample time (seconds) and Minimum number of packets
 
     [bookmark: pgfId-1536259]When the number of seconds specified elapses between performance statistics updates, the system verifies it has analyzed the specified number of packets. If it has, the system updates performance statistics. Otherwise, the system waits until it analyzes the specified number of packets.
 
     [bookmark: pgfId-1535679]Troubleshooting Options: Log Session/Protocol Distribution
 
     [bookmark: pgfId-1536452]Support might ask you during a troubleshooting call to log protocol distribution, packet length, and port statistics.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1536411] 
      Caution Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1535756]Troubleshooting Options: Summary
 
     [bookmark: pgfId-1536484]Support might ask you during a troubleshooting call to configure the system to calculate the performance statistics only when the Snort process is shut down or restarted. To enable this option, you must also enable the Log Session/Protocol Distribution troubleshooting option.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1536393] 
      Caution Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1535362]To configure basic performance statistics parameters:
 
     [bookmark: pgfId-1539971]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1535485]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1535486]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1535491]The access control policy editor appears.
 
     [bookmark: pgfId-1535492]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1535493]The access control policy advanced settings page appears.
 , then select the Performance Statistics tab in the pop-up window that appears. 
     
 
     [bookmark: pgfId-1535388]Step 5 Modify the Sample time or Minimum number of packets as described above.
 
     [bookmark: pgfId-1535391]Step 6 Optionally, expand the Troubleshoot Options section and modify those options only if asked to do so by Support.
 
     [bookmark: pgfId-1535548]Step 7 Click OK.
 
     [bookmark: pgfId-1535794]You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1535400]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1530432][bookmark: 78959]Tuning File and Malware Inspection Performance and Stor[bookmark: marker-1531618]age
 
    [bookmark: pgfId-1533577]License: Protection or Malware
 
    [bookmark: pgfId-1533581]Supported Devices: feature dependent
 
    [bookmark: pgfId-1540011]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1531578]If you use file policies to perform file control, file storage, dynamic analysis, or malware detection or blocking, you can set the options listed in the following table. Keep in mind that increasing the file sizes can affect the performance of the system.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1618615] 
     Caution Changing a value of an access control policy Files and Malware Settings advanced setting restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1531547]
 
     
      
       
       [bookmark: pgfId-1531442]Table 18-6 [bookmark: 41569]Advanced Access Control File and Malware Detection Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-1531452]Field 
         
  
        	 
          
          [bookmark: pgfId-1531454]Description 
         
  
        	 
          
          [bookmark: pgfId-1531456]Default Value 
         
  
        	 
          
          [bookmark: pgfId-1531458]Range 
         
  
        	 
          
          [bookmark: pgfId-1531460]Notes 
         
  
       
 
        
        	[bookmark: pgfId-1531462]Limit the number of bytes inspected when doing file type detection
  
        	[bookmark: pgfId-1531464]Specify the number of bytes inspected when performing file type detection.
  
        	[bookmark: pgfId-1531466]1460 bytes, or the maximum segment size of a TCP packet
  
        	[bookmark: pgfId-1531468]0 - 4294967295 (4GB)
  
        	[bookmark: pgfId-1531470]Set to 0 to remove the restriction.
 [bookmark: pgfId-1531471]In most cases, the system can identify common file types using the first packet.
  
       
 
        
        	[bookmark: pgfId-1531473]Do not calculate SHA-256 hash values for files larger than (in bytes)
  
        	[bookmark: pgfId-1531475]Prevent the system from storing files larger than a certain size, performing a Collective Security Intelligence Cloud lookup on the files, or blocking the files if added to the custom detection list.
  
        	[bookmark: pgfId-1531480]10485760 (10MB)
  
        	[bookmark: pgfId-1531482]0 - 4294967295 (4GB)
  
        	[bookmark: pgfId-1592691]Set to 0 to remove the restriction.
 [bookmark: pgfId-1531485]This value must be greater than or equal to Maximum file size to store (bytes) and Maximum file size for dynamic analysis testing (bytes). 
  
       
 
        
        	[bookmark: pgfId-1531487]Allow file if cloud lookup for Block Malware takes longer than (seconds)
  
        	[bookmark: pgfId-1592774]Specify how long the system will hold the last byte of a file that matches a Block Malware rule and that does not have a cached disposition, while malware cloud lookup occurs. If the time elapses without the system obtaining a disposition, the file passes. Dispositions of Unavailable are not cached.
  
        	[bookmark: pgfId-1531491]2 seconds
  
        	[bookmark: pgfId-1531493]0 - 30 seconds
  
        	[bookmark: pgfId-1531496]Although this option accepts values of up to 30 seconds, Cisco recommends that you use the default value to avoid blocking traffic because of connection failures. Do not set this option to 0 without contacting Support.
  
       
 
        
        	[bookmark: pgfId-1531504]Minimum file size to store (bytes)
  
        	[bookmark: pgfId-1531506]Specify the minimum file size the system can store using a file rule.
  
        	[bookmark: pgfId-1531508]6144 (6KB)
  
        	[bookmark: pgfId-1531510]0 - 10485760 (10MB)
  
        	[bookmark: pgfId-1592726]Set to 0 to disable file storage.
 [bookmark: pgfId-1531513]This field must be less than or equal to Maximum file size to store (bytes) and Do not calculate SHA-256 hash values for files larger than (in bytes).
  
       
 
        
        	[bookmark: pgfId-1531515]Maximum file size to store (bytes)
  
        	[bookmark: pgfId-1531517]Specify the maximum file size the system can store using a file rule.
  
        	[bookmark: pgfId-1531519]1048576 (1MB)
  
        	[bookmark: pgfId-1531521]0 - 10485760 (10MB)
  
        	[bookmark: pgfId-1531523]Set to 0 to disable file storage.
 [bookmark: pgfId-1531524]This field must be greater than or equal to Minimum file size to store (bytes), and less than or equal to Do not calculate SHA-256 hash values for files larger than (in bytes).
  
       
 
        
        	[bookmark: pgfId-1531526]Minimum file size for dynamic analysis testing (bytes)
  
        	[bookmark: pgfId-1531528]Specify the minimum file size the system can submit to the cloud for dynamic analysis.
  
        	[bookmark: pgfId-1531530]6144 (6KB)
  
        	[bookmark: pgfId-1531532]6144 (6KB) -2097152 (2MB)
  
        	[bookmark: pgfId-1531534]This field must be less than or equal to Maximum file size for dynamic analysis testing (bytes) and Do not calculate SHA-256 hash values for files larger than (in bytes).
 [bookmark: pgfId-1531535]The system checks the cloud for updates to the minimum file size you can submit (no more than once a day). If the new minimum size is larger than your current value, your current value is updated to the new minimum, and your policy is marked out-of-date.
  
       
 
        
        	[bookmark: pgfId-1531537]Maximum file size for dynamic analysis testing (bytes)
  
        	[bookmark: pgfId-1531539]Specify the maximum file size the system can submit to the cloud for dynamic analysis.
  
        	[bookmark: pgfId-1531541]1048576 (1MB)
  
        	[bookmark: pgfId-1531543]6144 (6KB) -2097152 (2MB)
  
        	[bookmark: pgfId-1531545]This field must be greater than or equal to Minimum file size for dynamic analysis testing (bytes), and less than or equal to Do not calculate SHA-256 hash values for files larger than (in bytes).
 [bookmark: pgfId-1531546]The system checks the cloud for updates to the maximum file size you can submit (no more than once a day). If the new maximum size is smaller than your current value, your current value is updated to the new maximum, and your policy is marked out-of-date.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1542042]Note that because you cannot use a Malware license with a DC500, nor enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to capture, store, or block individual files, analyze the contents of archive files, submit files for dynamic analysis, or view file trajectories for files for which you conduct a malware cloud lookup.
 
    [bookmark: pgfId-1541523]To configure file and malware inspection performance and storage:
 
    [bookmark: pgfId-1542883]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1541524]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1541525]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1541530]The access control policy editor appears.
 
    [bookmark: pgfId-1541531]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1541532]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1541962]The Files and Malware Settings pop-up window appears.
 
    [bookmark: pgfId-1541540]Step 5 You can set any of the options in the Advanced Access Control File and Malware Detection Options table.
 
    [bookmark: pgfId-1541543]Step 6 Click OK.
 
    [bookmark: pgfId-1541546]You must save and apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-1541548]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3626974][bookmark: 53624]Understanding Traffic Decryption 
      
      
 
     
 
 
    [bookmark: pgfId-3638456]By default, the system cannot inspect traffic encrypted with the Secure Socket Layer (SSL) or Transport Layer Security (TLS) protocols. As part of access control, the SSL inspection[bookmark: marker-3638457] feature allows you to either block encrypted traffic without inspecting it, or inspect encrypted or decrypted traffic with access control. As the system handles encrypted sessions, it logs details about the traffic. The combination of inspecting encrypted traffic and analyzing encrypted session data allows greater awareness and control of the encrypted applications and traffic in your network. 
 
    [bookmark: pgfId-3583114]If the system detects an SSL or TLS handshake over a TCP connection, it determines whether it can decrypt the detected traffic. If it cannot, it applies a configured action:
 
     
     	 [bookmark: pgfId-3585603]block the encrypted traffic, and optionally reset the TCP connection
 
     	 [bookmark: pgfId-3585604]not decrypt the encrypted traffic 
 
    
 
    [bookmark: pgfId-3635490]Note that access control rules handle encrypted traffic when your SSL inspection configuration allows it to pass, or if you do not configure SSL inspection. However, some access control rule conditions require unencrypted traffic, so encrypted traffic may match fewer rules. Also, by default, the system disables intrusion and file inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured. For more information, see Creating and Editing Access Control Rules and Using the SSL Preprocessor.
 
    [bookmark: pgfId-3635226]If the system can decrypt the traffic, it blocks the traffic without further inspection, evaluates undecrypted traffic with access control, or decrypts it using one of the following methods:
 
     
     	 [bookmark: pgfId-3585434]Decrypt with a known private key. When an external host initiates an SSL handshake with a server on your network, the system matches the exchanged server certificate with a server certificate previously uploaded to the appliance. It then uses the uploaded private key to decrypt the traffic.
 
     	 [bookmark: pgfId-3633154]Decrypt by re-signing the server certificate. When a host on your network initiates an SSL handshake with an external server, the system re-signs the exchanged server certificate with a previously uploaded certificate authority (CA) certificate. It then uses the uploaded private key to decrypt the traffic.
 
    
 
    [bookmark: pgfId-3633155]Decrypted traffic is subject to the same traffic handling and analysis as originally unencrypted traffic: network, reputation, and user-based access control; intrusion detection and prevention; advanced malware protection; and discovery. If the system does not block the decrypted traffic post-analysis, it reencrypts the traffic before passing it to the destination host. 
 
     
      
    
 
    
 
    [bookmark: pgfId-3585997]Note Certain SSL inspection actions, such as blocking traffic and decrypting outgoing traffic, modify the flow of traffic. Devices deployed inline can perform these actions. Devices deployed passively or in tap mode cannot affect the flow of traffic. However, these devices can still decrypt incoming traffic; see Example: Decrypting Traffic in a Passive Deployment for more information. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3486290]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3605846]SSL Inspection Requirements
 
     	 [bookmark: pgfId-3605713]Analyzing SSL Inspection Appliance Deployments
 
    
 
   
 
    
     [bookmark: pgfId-3605721][bookmark: 51678]SSL Inspection Requirements
 
    [bookmark: pgfId-3606901]License: feature dependent
 
    [bookmark: pgfId-3630635]Supported Devices: Series 3
 
    [bookmark: pgfId-3606902]Only certain appliance models support SSL inspection. How you deploy the appliances on your network, in addition to your configuration settings and licenses, influences the actions you can take to control and decrypt encrypted traffic.
 
    [bookmark: pgfId-3609019]Available features and actions to configure SSL inspection depend on your user role. The system includes predefined user roles designed for a variety of administrators and analysts, and you can create custom user roles with specialized access privileges. 
 
    [bookmark: pgfId-3608506]SSL inspection requires public key certificates and paired private keys for certain features. You must upload certificates and paired private keys to the Defense Center to decrypt and control traffic based on encryption session characteristics.
 
    [bookmark: pgfId-3607130]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3607155]Deploying Appliances that Support SSL Inspection
 
     	 [bookmark: pgfId-3607159]Determining Necessary Licenses for SSL Inspection
 
     	 [bookmark: pgfId-3607162]Managing Your SSL Inspection Deployment with Custom User Roles
 
     	 [bookmark: pgfId-3607680]Collecting Prerequisite Information to Configure SSL Rules
 
    
 
     
      [bookmark: pgfId-3606904][bookmark: 30081]Deploying Appliances that Support SSL Inspection
 
     [bookmark: pgfId-3621292]License: Any
 
     [bookmark: pgfId-3606226]Supported Devices: Series 3
 
     [bookmark: pgfId-3606238]SSL inspection requires a Series 3 device. 
 
     [bookmark: pgfId-3606242]Devices configured and deployed with inline, routed, switched, or hybrid interfaces can modify the flow of traffic. These devices can monitor, block, allow, and decrypt incoming and outgoing traffic. 
 
     [bookmark: pgfId-3621332]Devices configured and deployed with passive or inline (tap mode) interfaces cannot affect the flow of traffic. They can only monitor, allow, and decrypt incoming traffic. Note that passive deployments do not support decrypting traffic encrypted with the ephemeral Diffie-Hellman (DHE) or the elliptic curve Diffie-Hellman (ECDHE) cipher suites. 
 
     [bookmark: pgfId-3621525]Review your list of mapped actions, existing network deployment, and overall requirements to determine whether one or the other type of deployment better suits your organization. See Analyzing SSL Inspection Appliance Deployments for more information.
 
    
 
     
      [bookmark: pgfId-3606273][bookmark: 73176]Determining Necessary Licenses for SSL Inspection
 
     [bookmark: pgfId-3606274]License: feature dependent
 ) and confirmation dialog boxes to designate unsupported features for your deployment. For details, hover your pointer over a warning icon. 
     
 
     [bookmark: pgfId-3606289]You apply an SSL policy to a managed device as part of an access control policy, and the access control policy inspects traffic decrypted by the SSL policy. See Access Control License and Role Requirements for more information on access control licensing.
 
     [bookmark: pgfId-3606294]Th[bookmark: marker-3606293]e following table explains the license requirements to apply an SSL policy as part of an access control policy. 
 
     [bookmark: pgfId-3606321]
 
      
       
        
        [bookmark: pgfId-3606300]Table 19-1 License and Model Requirements for SSL Inspection 
 
        
        
         
         	 
           
           [bookmark: pgfId-3637555]To apply an SSL policy that... 
          
  
         	 
           
           [bookmark: pgfId-3637557]Licenses 
          
  
         	 
           
           [bookmark: pgfId-3637562]Supported Defense Centers 
          
  
         	 
           
           [bookmark: pgfId-3637564]Supported Devices 
          
  
        
 
         
         	[bookmark: pgfId-3637566]handles encrypted traffic on the basis of zone, network, VLAN, port, or SSL-related criteria
  
         	[bookmark: pgfId-3637568]Any
  
         	[bookmark: pgfId-3637570]Any
  
         	[bookmark: pgfId-3637575]Series 3
  
        
 
         
         	[bookmark: pgfId-3637577]handles encrypted traffic using geolocation data
  
         	[bookmark: pgfId-3637582]FireSIGHT
  
         	[bookmark: pgfId-3637584]Any except DC500
  
         	[bookmark: pgfId-3637589]Series 3
  
        
 
         
         	[bookmark: pgfId-3637591]handles encrypted traffic using application or user criteria
  
         	[bookmark: pgfId-3637593]Control
  
         	[bookmark: pgfId-3637598]Any, except the DC500 cannot perform user control
  
         	[bookmark: pgfId-3637603]Series 3
  
        
 
         
         	[bookmark: pgfId-3637605]filters encrypted traffic using URL category and reputation data
  
         	[bookmark: pgfId-3637610]URL Filtering
  
         	[bookmark: pgfId-3637615]Any except DC500
  
         	[bookmark: pgfId-3637620]Series 3
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3606323][bookmark: 10856]Managing Your SSL Inspection Deployment with Custom User Roles
 
     [bookmark: pgfId-3621314]License: Any
 
      
       
        
        [bookmark: pgfId-3606335]Table 19-2 SSL Inspection-Related User Role Permissions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3606339]User Permission 
          
  
         	 
           
           [bookmark: pgfId-3606341]Description 
          
  
        
 
         
         	[bookmark: pgfId-3606343]Object Manager
  
         	[bookmark: pgfId-3606345]allows you to create, modify, and delete objects related to SSL inspection
  
        
 
         
         	[bookmark: pgfId-3606347]SSL
  
         	[bookmark: pgfId-3606349]allows you to generate reports for SSL policies and compare SSL policies or policy revisions
  
        
 
         
         	[bookmark: pgfId-3606351]Modify SSL Policy
  
         	[bookmark: pgfId-3606353]allows you to view, create, modify, and delete an SSL policy, and create, modify, and delete SSL rules not in the Administrator Rules or Root Rules categories
  
        
 
         
         	[bookmark: pgfId-3606355]Modify Administrator Rules
  
         	[bookmark: pgfId-3606357]allows you to create, modify, and delete SSL rules in the Administrator Rules category
  
        
 
         
         	[bookmark: pgfId-3606359]Modify Root Rules 
  
         	[bookmark: pgfId-3606361]allows you to create, modify, and delete SSL rules in the Root Rules category
  
        
 
         
         	[bookmark: pgfId-3606363]Apply SSL Policy
  
         	[bookmark: pgfId-3606365]allows you to apply an SSL policy if you apply the access control policy with which it is associated
  
        
 
         
         	[bookmark: pgfId-3606367]Access Control List
  
         	[bookmark: pgfId-3606369]allows you to view the list of access control policies
  
        
 
         
         	[bookmark: pgfId-3606371]Modify Access Control Policy 
  
         	[bookmark: pgfId-3606373]allows you to associate an SSL policy with an access control policy
  
        
 
         
         	[bookmark: pgfId-3606375]Apply Access Control Policies
  
         	[bookmark: pgfId-3606377]allows you to apply the access control policy associated with the SSL policy
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3606381]For more information, see Access Control License and Role Requirements.
 
    
 
     
      [bookmark: pgfId-3521890][bookmark: 91519]Collecting Prerequisite Information to Configure SSL Rules
 
     [bookmark: pgfId-3565582]License: feature-dependent
 
     [bookmark: pgfId-3567880]SSL inspection relies on a significant amount of supporting public key infrastructure (PKI) information. Consider your organization’s traffic patterns to determine the matching rule conditions you can configure. Collect the information listed in the following table:
 
     [bookmark: pgfId-3558414]
 
      
       
        
        [bookmark: pgfId-3559215]Table 19-3 [bookmark: 70715]SSL Rule Condition Prerequisites 
 
        
        
         
         	 
           
           [bookmark: pgfId-3559219]To match on... 
          
  
         	 
           
           [bookmark: pgfId-3559221]Collect the... 
          
  
        
 
         
         	[bookmark: pgfId-3559263]detected server certificates, including self-signed server certificates
  
         	[bookmark: pgfId-3559265]server certificate
  
        
 
         
         	[bookmark: pgfId-3587020]trusted server certificates
  
         	[bookmark: pgfId-3587022]CA certificate
  
        
 
         
         	[bookmark: pgfId-3559271]detected server certificate subject or issuer
  
         	[bookmark: pgfId-3559273]server certificate subject DN or issuer DN
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3522812]For more information, see Tuning Traffic Decryption Using SSL Rules.
 
      
       
        
        [bookmark: pgfId-3561258]Table 19-4 [bookmark: 11996]SSL Decryption Prerequisites 
 
        
        
         
         	 
           
           [bookmark: pgfId-3561262]To decrypt... 
          
  
         	 
           
           [bookmark: pgfId-3561264]Collect... 
          
  
        
 
         
         	[bookmark: pgfId-3561266]incoming traffic to a server you control
  
         	[bookmark: pgfId-3561268]the server’s certificate file and paired private key file
  
        
 
         
         	[bookmark: pgfId-3561270]outgoing traffic to an external server
  
         	[bookmark: pgfId-3561272]a CA certificate file and paired private key file
 [bookmark: pgfId-3561273]You can also generate a CA certificate and private key.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3561278]For more information, see Using Rule Actions to Determine Encrypted Traffic Handling and Inspection.
 
     [bookmark: pgfId-3607332]After you have collected this information, upload it to the system and configure reusable objects. See Managing Reusable Objects for more information. 
 
    
 
   
 
    
     [bookmark: pgfId-3522940][bookmark: 12223]Analyzing SSL Inspection Appliance Deployments
 
    [bookmark: pgfId-3630517]License: feature-dependent
 
    [bookmark: pgfId-3630524]Supported Devices: Series 3
 
    [bookmark: pgfId-3515223]This section presents several scenarios in which the Life Insurance Example, Inc. life insurance company (LifeIns) uses SSL inspection on encrypted traffic to help audit their processes. Based on their business processes, LifeIns plans to deploy:
 
     
     	 [bookmark: pgfId-3621603]one Series 3 managed device in a passive deployment for the Customer Service department
 
     	 [bookmark: pgfId-3621649]one Series 3 managed device in an inline deployment for the Underwriting Department
 
     	 [bookmark: pgfId-3621652]one Defense Center to manage both devices
 
    
 
    [bookmark: pgfId-3504986]Customer Service Business Processes
 
    [bookmark: pgfId-3515440]LifeIns created a customer-facing website for their customers. LifeIns receives encrypted questions and requests regarding policies from prospective customers through their website and through e-mail. LifeIns’s Customer Service department processes them and returns the requested information within 24 hours. Customer Service wants to expand its incoming contact metrics collection. LifeIns has an established internal audit review for Customer Service. 
 
    [bookmark: pgfId-3504957]LifeIns also receives encrypted applications online. The Customer Service department processes the applications within 24 hours before sending the case file to the Underwriting department. Customer Service filters out any obvious false applications sent through the online form, which consumes a fair portion of their time.
 
    [bookmark: pgfId-3515489]Underwriting Business Processes
 
    [bookmark: pgfId-3434579]LifeIns’s underwriters submit encrypted medical information requests online to the Medical Repository Example, LLC medical data repository (MedRepo). MedRepo reviews the requests and transmits the encrypted records to LifeIns within 72 hours. The underwriters subsequently underwrite an application and submit policy and rate decisions. Underwriting wants to expand its metrics collection.
 
    [bookmark: pgfId-3507669]Lately, an unknown source has been sending spoofed responses to LifeIns. Though LifeIns’s underwriters receive training on proper Internet use, LifeIns’s IT department first wants to analyze all encrypted traffic that takes the form of medical responses, then wants to block all spoof attempts.
 
    [bookmark: pgfId-3434833]LifeIns places junior underwriters on six-month training periods. Lately, these underwriters have been incorrectly submitting encrypted medical regulation requests to MedRepo’s customer service department. MedRepo has submitted multiple complaints to LifeIns in response. LifeIns plans on extending their new underwriter training period to also audit underwriter requests to MedRepo.
 
    [bookmark: pgfId-3432075]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3432090]Example: Decrypting Traffic in a Passive Deployment
 
     	 [bookmark: pgfId-3432083]Example: Decrypting Traffic in an Inline Deployment
 
    
 
     
      [bookmark: pgfId-3427117][bookmark: 97158]Example: Decrypting Traffic in a Passive [bookmark: marker-3577850]Deployment
 
     [bookmark: pgfId-3622715]License: feature-dependent
 
     [bookmark: pgfId-3622722]Supported Devices: Series 3
 
     [bookmark: pgfId-3427119]LifeIns’s business requirements state that Customer Service must:
 
      
      	 [bookmark: pgfId-3427120]process all requests and applications within 24 hours
 
      	 [bookmark: pgfId-3505951]improve its incoming contact metrics collection process
 
      	 [bookmark: pgfId-3528908]identify and discard incoming false applications
 
     
 
     [bookmark: pgfId-3427121]Customer Service does not require additional audit review.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3590850]Traffic from an external network goes to LifeIns’s router. The router routes traffic to the Customer Service department, and mirrors a copy of the traffic to the managed device for inspection. 
 
     [bookmark: pgfId-3508496]On the managing Defense Center, a user in the Access Control and SSL Editor custom role configures SSL inspection to:
 
      
      	 [bookmark: pgfId-3591071]log all encrypted traffic sent to the Customer Service department
 
      	 [bookmark: pgfId-3591178]decrypt encrypted traffic sent using the online application form to Customer Service
 
      	 [bookmark: pgfId-3591305]not decrypt all other encrypted traffic sent to Customer service, including traffic sent using the online request form
 
     
 
     [bookmark: pgfId-3530350]The user also configures access control to inspect the decrypted application form traffic for fake application data and log when fake data is detected.
 
     [bookmark: pgfId-3576184]In the following scenarios, the user submits an online form to Customer Service. The user’s browser establishes a TCP connection with the server, then initiates an SSL handshake. The managed device receives a copy of this traffic. The client and server complete the SSL handshake, establishing the encrypted session. Based on handshake and connection details, the system logs the connection and acts upon the copy of the encrypted traffic.
 
     [bookmark: pgfId-3529472]For more information, see the following:
 
      
      	 [bookmark: pgfId-3529476]Monitoring Encrypted Traffic in a Passive Deployment
 
      	 [bookmark: pgfId-3529487]Not Decrypting Encrypted Traffic in a Passive Deployment
 
      	 [bookmark: pgfId-3528182]Inspecting Encrypted Traffic with a Private Key in a Passive Deployment
 
     
 
    
 
     
      [bookmark: pgfId-3529262][bookmark: 69054]Monitoring Encrypted Traffic in a Passive Deployment
 
     [bookmark: pgfId-3622769]License: Any
 
     [bookmark: pgfId-3622776]Supported Devices: Series 3
 
     [bookmark: pgfId-3529338]For all SSL-encrypted traffic sent to Customer Service, the system logs the connection. The following diagram illustrates the system monitoring encrypted traffic.
 
     [bookmark: pgfId-3643971]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3529348]The following steps occur:
 
     [bookmark: pgfId-3529349] 1. The user submits the plain text request (info). The client encrypts this (AaBb) and sends the encrypted traffic to Customer Service.
 
     [bookmark: pgfId-3529350] 2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the managed device.
 
     [bookmark: pgfId-3529351] 3. The Customer Service department server receives the encrypted information request (AaBb) and decrypts it to plain text (info).
 
     [bookmark: pgfId-3529352] 4. The managed device does not decrypt the traffic.
 
     [bookmark: pgfId-3633815]The access control policy continues to process the encrypted traffic and allows it. The device generates a connection event after the session ends.
 
     [bookmark: pgfId-3529359] 5. The Defense Center receives the connection event.
 
    
 
     
      [bookmark: pgfId-3528185][bookmark: 71179]Not Decrypting Encrypted Traffic in a Passive Deployment
 
     [bookmark: pgfId-3622826]License: Any
 
     [bookmark: pgfId-3622833]Supported Devices: Series 3
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3614332]The following steps occur:
 
     [bookmark: pgfId-3514300] 1. The user submits the plain text request (info). The client encrypts this (AaBb) and sends the encrypted traffic to Customer Service.
 
     [bookmark: pgfId-3514301] 2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the managed device.
 
     [bookmark: pgfId-3514302] 3. The Customer Service department server receives the encrypted information request (AaBb) and decrypts it to plain text (info).
 
     [bookmark: pgfId-3514303] 4. The managed device does not decrypt the traffic. 
 
     [bookmark: pgfId-3633869]The access control policy continues to process the encrypted traffic and allows it. The device generates a connection event after the session ends.
 
     [bookmark: pgfId-3633857] 5. The Defense Center receives the connection event.
 
    
 
     
      [bookmark: pgfId-3427139][bookmark: 69541]Inspecting Encrypted Traffic with a Private Key in a Passive Deployment
 
     [bookmark: pgfId-3622869]License: Any
 
     [bookmark: pgfId-3622876]Supported Devices: Series 3
 
     [bookmark: pgfId-3510158]For all SSL-encrypted traffic that contains application form data, the system decrypts the traffic and logs the connection. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3622465]Note In a passive deployment, if traffic is encrypted with either the DHE or ECDHE cipher suite, you cannot decrypt it with a known private key.
 
      
      
 
     
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3621874]The following steps occur:
 
     [bookmark: pgfId-3510133] 1. The user submits the plain text request (form). The client encrypts this (AaBb) and sends the encrypted traffic to Customer Service.
 
     [bookmark: pgfId-3510134] 2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the managed device.
 
     [bookmark: pgfId-3427155] 3. The Customer Service department server receives the encrypted information request (AaBb) and decrypts it to plain text (form).
 
     [bookmark: pgfId-3427156] 4. The managed device uses the session key obtained with the uploaded known private key to decrypt the encrypted traffic to plain text (form). 
 
     [bookmark: pgfId-3632695]The access control policy continues to process the decrypted traffic and does not find fake application information. The device generates a connection event after the session ends.
 
     [bookmark: pgfId-3427163] 5. The Defense Center receives a connection event with information about the encrypted and decrypted traffic.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3621896]The following steps occur:
 
     [bookmark: pgfId-3530952] 1. The user submits the plain text request (fake). The client encrypts this (CcDd) and sends the encrypted traffic to Customer Service.
 
     [bookmark: pgfId-3530953] 2. LifeIns's router receives the encrypted traffic and routes it to the Customer Service department server. It also mirrors a copy to the managed device.
 
     [bookmark: pgfId-3530954] 3. The Customer Service department server receives the encrypted information request (CcDd) and decrypts it to plain text (fake).
 
     [bookmark: pgfId-3532104] 4. The managed device uses the session key obtained with the uploaded known private key to decrypt the encrypted traffic to plain text (fake). 
 
     [bookmark: pgfId-3549588]The access control policy continues to process the decrypted traffic and finds fake application information. The device generates an intrusion event. After the session ends, it generates a connection event.
 
     [bookmark: pgfId-3549595] 5. The Defense Center receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the fake application data.
 
    
 
     
      [bookmark: pgfId-3427194][bookmark: 75117]Example: Decrypting Traffic in an Inline [bookmark: marker-3577872]Deployment
 
     [bookmark: pgfId-3622912]License: feature-dependent
 
     [bookmark: pgfId-3622919]Supported Devices: Series 3
 
     [bookmark: pgfId-3427196]LifeIns’s business requirements state that Underwriting must:
 
      
      	 [bookmark: pgfId-3506915]audit new and junior underwriters, verifying that their information requests to MedRepo comply with all applicable regulations
 
      	 [bookmark: pgfId-3532715]improve its underwriting metrics collection process
 
      	 [bookmark: pgfId-3532706]examine all requests that appear to come from MedRepo, then drop any spoofing attempts
 
      	 [bookmark: pgfId-3427199]drop all improper regulatory requests to MedRepo’s Customer Service department from the Underwriting department
 
      	 [bookmark: pgfId-3427200]not audit senior underwriters
 
     
 
     [bookmark: pgfId-3480126]LifeIns plans to deploy a device in an inline deployment for the Underwriting department. The following diagram illustrates LifeIns’s inline deployment.
 
     [bookmark: pgfId-3644067]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3614460]Traffic from MedRepo’s network goes to MedRepo’s router. It routes traffic to LifeIns’s network. The managed device receives the traffic, passes allowed traffic to LifeIns’s router, and sends events to the managing Defense Center. LifeIns’s router routes traffic to the destination host.
 
     [bookmark: pgfId-3511719]On the managing Defense Center, a user in the Access Control and SSL Editor custom role configures SSL inspection to:
 
      
      	 [bookmark: pgfId-3592970]log all encrypted traffic sent to the Underwriting department
 
      	 [bookmark: pgfId-3593325]block all encrypted traffic incorrectly sent from LifeIns’s underwriting department to MedRepo’s customer service department
 
      	 [bookmark: pgfId-3593489]decrypt all encrypted traffic sent from MedRepo to LifeIns’s underwriting department, and from LifeIns’s junior underwriters to MedRepo’s requests department
 
      	 [bookmark: pgfId-3593203]not decrypt encrypted traffic sent from the senior underwriters
 
     
 
     [bookmark: pgfId-3593709]The user also configures access control to inspect decrypted traffic with a custom intrusion policy and:
 
      
      	 [bookmark: pgfId-3593799]block decrypted traffic if it contains a spoof attempt, and log the spoof attempt
 
      	 [bookmark: pgfId-3593932]block decrypted traffic that contains information not compliant with regulations, and log the improper information
 
      	 [bookmark: pgfId-3594089]allow all other encrypted and decrypted traffic
 
     
 
     [bookmark: pgfId-3596057]The system reencrypts allowed decrypted traffic before sending it to the destination host.
 
     [bookmark: pgfId-3552765]In the following scenarios, the user submits information online to a remote server. The user’s browser establishes a TCP connection with the server, then initiates an SSL handshake. The managed device receives this traffic; based on handshake and connection details, the system logs the connection and acts on the traffic. If the system blocks the traffic, it also closes the TCP connection. Otherwise, the client and server complete the SSL handshake, establishing the encrypted session. 
 
     [bookmark: pgfId-3511327]For more information, see the following:
 
      
      	 [bookmark: pgfId-3533957]Monitoring Encrypted Traffic in an Inline Deployment
 
      	 [bookmark: pgfId-3511335]Allowing Specific Users’ Encrypted Traffic in an Inline Deployment
 
      	 [bookmark: pgfId-3511339]Blocking Encrypted Traffic in an Inline Deployment
 
      	 [bookmark: pgfId-3511342]Inspecting Encrypted Traffic with a Private Key in an Inline Deployment
 
      	 [bookmark: pgfId-3511346]Inspecting Specific Users’ Encrypted Traffic with a Re-signed Certificate in an Inline Deployment
 
     
 
    
 
     
      [bookmark: pgfId-3533761][bookmark: 94564]Monitoring Encrypted Traffic in an Inline Deployment
 
     [bookmark: pgfId-3622963]License: Any
 
     [bookmark: pgfId-3622970]Supported Devices: Series 3
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3621908]The following steps occur:
 
     [bookmark: pgfId-3533834] 1. The user submits the plain text request (help). The client encrypts this (AaBb) and sends the encrypted traffic to MedRepo’s Requests department server.
 
     [bookmark: pgfId-3533835] 2. LifeIns's router receives the encrypted traffic and routes it to the Requests department server. 
 
     [bookmark: pgfId-3533836] 3. The managed device does not decrypt the traffic. 
 
     [bookmark: pgfId-3633949]The access control policy continues to process the encrypted traffic and allows it, then generates a connection event after the session ends.
 
     [bookmark: pgfId-3533840] 4. The external router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3533841] 5. The Underwriting department server receives the encrypted information request (AaBb) and decrypts it to plain text (help).
 
     [bookmark: pgfId-3533923] 6. The Defense Center receives the connection event.
 
    
 
     
      [bookmark: pgfId-3533925][bookmark: 88980]Allowing Specific Users’ Encrypted Traffic in an Inline Deployment
 
     [bookmark: pgfId-3623046]License: Control
 
     [bookmark: pgfId-3623053]Supported Devices: Series 3
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3621956]The following steps occur:
 
     [bookmark: pgfId-3621942] 1. The user submits the plain text request (help). The client encrypts this (AaBb) and sends the encrypted traffic to MedRepo’s Requests department server.
 
     [bookmark: pgfId-3427235] 2. LifeIns's router receives the encrypted traffic and routes it to the Requests department server. 
 
     [bookmark: pgfId-3427236] 3. The managed device does not decrypt this traffic. 
 
     [bookmark: pgfId-3634009]The access control policy continues to process the encrypted traffic and allows it, then generates a connection event after the session ends.
 
     [bookmark: pgfId-3512160] 4. The external router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3512161] 5. The Requests department server receives the encrypted information request (AaBb) and decrypts it to plain text (help).
 
     [bookmark: pgfId-3427245] 6. The Defense Center receives the connection event.
 
    
 
     
      [bookmark: pgfId-3427246][bookmark: 82209]Blocking Encrypted Traffic in an Inline Deployment
 
     [bookmark: pgfId-3623093]License: Any
 
     [bookmark: pgfId-3623100]Supported Devices: Series 3
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3621968]The following steps occur:
 
     [bookmark: pgfId-3485656] 1. Having received the request to establish an SSL handshake from a client’s browser, the Customer Service department server sends the server certificate (cert) as the next step in the SSL handshake to the LifeIns underwriter.
 
     [bookmark: pgfId-3427261] 2. MedRepo’s router receives the certificate and routes it to the LifeIns underwriter. 
 
     [bookmark: pgfId-3427262] 3. The managed device blocks the traffic without further inspection and ends the TCP connection. It generates a connection event. 
 
     [bookmark: pgfId-3427266] 4. The internal router does not receive the blocked traffic.
 
     [bookmark: pgfId-3427267] 5. The underwriter does not receive the blocked traffic.
 
     [bookmark: pgfId-3427271] 6. The Defense Center receives the connection event.
 
    
 
     
      [bookmark: pgfId-3427273][bookmark: 88502]Inspecting Encrypted Traffic with a Private Key in an Inline Deployment
 
     [bookmark: pgfId-3623148]License: Any
 
     [bookmark: pgfId-3623155]Supported Devices: Series 3
 
     [bookmark: pgfId-3457714]For all SSL-encrypted traffic sent from MedRepo to LifeIns’s underwriting department, the system uses an uploaded server private key to obtain session keys, then decrypts the traffic and logs the connection. Legitimate traffic is allowed and reencrypted before being sent to the Underwriting department. 
 
     [bookmark: pgfId-3611599]The following diagram illustrates the system decrypting encrypted traffic with a known private key, then inspecting the traffic using access control and allowing the decrypted traffic.
 
     [bookmark: pgfId-3644163]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3621980]The following steps occur:
 
     [bookmark: pgfId-3466075] 1. The user submits the plain text request (stats). The client encrypts this (AaBbC) and sends the encrypted traffic to the Underwriting department server.
 
     [bookmark: pgfId-3427288] 2. The external router receives the traffic and routes it to the Underwriting department server.
 
     [bookmark: pgfId-3427289] 3. The managed device uses the session key obtained with the uploaded known private key to decrypt this traffic to plain text (stats). 
 
     [bookmark: pgfId-3514796]The access control policy continues to process the decrypted traffic with the custom intrusion policy and does not find a spoof attempt. The device passes the encrypted traffic (AaBbC), then generates a connection event after the session ends.
 
     [bookmark: pgfId-3427293] 4. The internal router receives the traffic and routes it to the Underwriting department server.
 
     [bookmark: pgfId-3427294] 5. The Underwriting department server receives the encrypted information (AaBbC) and decrypts it to plain text (stats).
 
     [bookmark: pgfId-3480335] 6. The Defense Center receives the connection event with information about the encrypted and decrypted traffic.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3622000]The following steps occur:
 
     [bookmark: pgfId-3525263] 1. The user submits the plain text request (spoof), altering the traffic to appear to originate from MedRepo, LLC. The client encrypts this (FfGgH) and sends the encrypted traffic to the Underwriting department server.
 
     [bookmark: pgfId-3525265] 2. The managed device uses the session key obtained with the uploaded known private key to decrypt this traffic to plain text (spoof).
 
     [bookmark: pgfId-3525266]The access control policy continues to process the decrypted traffic with the custom intrusion policy and finds a spoof attempt. The device blocks the traffic, then generates an intrusion event. It generates a connection event after the session ends.
 
     [bookmark: pgfId-3594558] 3. The internal router does not receive the blocked traffic.
 
     [bookmark: pgfId-3525272] 4. The Underwriting department server does not receive the blocked traffic.
 
     [bookmark: pgfId-3525276] 5. The Defense Center receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the spoofing attempt.
 
    
 
     
      [bookmark: pgfId-3480336][bookmark: 24605]Inspecting Specific Users’ Encrypted Traffic with a Re-signed Certificate in an Inline Deployment
 
     [bookmark: pgfId-3623187]License: Control
 
     [bookmark: pgfId-3623194]Supported Devices: Series 3
 
     [bookmark: pgfId-3480337]For all SSL-encrypted traffic sent from the new and junior underwriters to MedRepo’s requests department, the system uses a re-signed server certificate to obtain session keys, then decrypts the traffic and logs the connection. Legitimate traffic is allowed and reencrypted before being sent to MedRepo. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3571290]Note When decrypting traffic in an inline deployment by re-signing the server certificate, the device acts as a man-in-the-middle. It creates two SSL sessions, one between client and managed device, one between managed device and server. As a result, each session contains different cryptographic session details.
 
      
      
 
     
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3622012]The following steps occur:
 
     [bookmark: pgfId-3427315] 1. The user submits the plain text request (help). The client encrypts this (AaBb) and sends the encrypted traffic to the Requests department server.
 
     [bookmark: pgfId-3427317] 2. The internal router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3516692] 3. The managed device uses the session key obtained with a re-signed server certificate and private key to decrypt this traffic to plain text (help). 
 
     [bookmark: pgfId-3626616]The access control policy continues to process the decrypted traffic with the custom intrusion policy and does not find an improper request. The device reencrypts the traffic (CcDd), allowing it to pass. It generates a connection event after the session ends.
 
     [bookmark: pgfId-3427322] 4. The external router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3427323] 5. The Requests department server receives the encrypted information (CcDd) and decrypts it to plain text (help).
 
     [bookmark: pgfId-3427327] 6. The Defense Center receives the connection event with information about the encrypted and decrypted traffic.
 
      
       
     
 
     
 
     [bookmark: pgfId-3603798]Note Traffic encrypted with a re-signed server certificate causes client browsers to warn that the certificate is not trusted. To avoid this, add the CA certificate to the organization’s domain root trusted certificates store or the client trusted certificates store.
 
      
      
 
     
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3622032]The following steps occur:
 
     [bookmark: pgfId-3526076] 1. The user submits the plain text request (regs), which does not comply with regulatory requirements. The client encrypts this (EeFf) and sends the encrypted traffic to the Requests department server.
 
     [bookmark: pgfId-3526077] 2. The internal router receives the traffic and routes it to the Requests department server.
 
     [bookmark: pgfId-3526862] 3. The managed device uses the session key obtained with a re-signed server certificate and private key to decrypt this traffic to plain text (regs). 
 
     [bookmark: pgfId-3574299]The access control policy continues to process the decrypted traffic with the custom intrusion policy and finds an improper request. The device blocks the traffic, then generates an intrusion event. It generates a connection event after the session ends.
 
     [bookmark: pgfId-3526081] 4. The external router does not receive the blocked traffic.
 
     [bookmark: pgfId-3526082] 5. The Requests department server does not receive the blocked traffic.
 
     [bookmark: pgfId-3526086] 6. The Defense Center receives a connection event with information about the encrypted and decrypted traffic, and an intrusion event for the improper request.
 
      
       [bookmark: pgfId-3405144]
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3400437][bookmark: 94448]Getting Started with SSL Policies 
      
      
 
     
 
 
    [bookmark: pgfId-3400416]An SSL policy[bookmark: marker-3468749] determines how the system handles encrypted traffic on your network. You can configure one or more SSL policies. You associate an SSL policy with an access control policy, then apply the access control policy to a managed device. When the device detects a TCP handshake, the access control policy first handles and inspects the traffic. If it subsequently identifies an SSL-encrypted session over the TCP connection, the SSL policy takes over, handling and decrypting the encrypted traffic. You can have one SSL policy currently applied to a Series 3 device.
 
    [bookmark: pgfId-3419157]The simplest SSL policy, as shown in the following diagram, directs the device where it is applied to handle encrypted traffic with a single default action. You can set the default action to block decryptable traffic without further inspection, or inspect undecrypted decryptable traffic with access control. The system can then either allow or block the encrypted traffic. If the device detects undecryptable traffic, it either blocks the traffic without further inspection or does not decrypt it, inspecting it with access control. 
 
    [bookmark: pgfId-3473614]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3405638]This chapter explains how to create and apply a simple SSL policy. It also contains basic information on managing SSL policies: editing, updating, comparing, and so on. For more information, see:
 
     
     	 [bookmark: pgfId-3406082]Creating a Basic SSL Policy
 
     	 [bookmark: pgfId-3406089]Editing an SSL Policy
 
     	 [bookmark: pgfId-3430021]Applying Decryption Settings Using Access Control
 
     	 [bookmark: pgfId-3412610]Generating a Report of Current Traffic Decryption Settings
 
     	 [bookmark: pgfId-3406096]Comparing SSL Policies
 
    
 
    [bookmark: pgfId-3429807]A more complex SSL policy can handle different types of undecryptable traffic with different actions, control traffic based on whether a certificate authority (CA) issued or trusts the encryption certificate, and use SSL rules to exert granular control over encrypted traffic logging and handling. These rules can be simple or complex, matching and inspecting encrypted traffic using multiple criteria. After you create a basic SSL policy, see the following chapters for more information on tailoring it to your deployment:
 
     
     	 [bookmark: pgfId-3430502]Managing Reusable Objects describes how to configure reusable public key infrastructure (PKI) objects and other SSL inspection-related objects to enhance encrypted traffic control and decrypt traffic.
 
     	 [bookmark: pgfId-3431320]Logging Connections in Network Traffic describes how to configure logging for encrypted traffic, whether decryptable or undecryptable.
 
     	 [bookmark: pgfId-3455296]Applying Decryption Settings Using Access Control describes how to associate an SSL policy with an access control policy.
 
     	 [bookmark: pgfId-3430431]Getting Started with Access Control Policies describes how to apply an access control policy to a device.
 
     	 [bookmark: pgfId-3431934]Tuning Traffic Flow Using Access Control Rules describes how to configure access control rules to inspect decrypted traffic.
 
     	 [bookmark: pgfId-3430562]Getting Started with SSL Rules describes how to configure SSL rules to handle and log encrypted traffic. 
 
     	 [bookmark: pgfId-3430451]Tuning Traffic Decryption Using SSL Rules describes how to configure SSL rule conditions to better match specific encrypted traffic.
 
    
 
   
 
    
     [bookmark: pgfId-3405300][bookmark: 31181][bookmark: 41531][bookmark: 30403]Creating a Basic SSL [bookmark: marker-3419122]Policy
 
    [bookmark: pgfId-3443130]License: Any
 
    [bookmark: pgfId-3443134]Supported Devices: Series 3
 
    [bookmark: pgfId-3419250]When you create a new SSL policy you must, at minimum, give it a unique name and specify a policy default action. You have the following options when selecting a default action for a new policy:
 
     
     	 [bookmark: pgfId-3419251] Do not decrypt creates a policy with the Do not decrypt default action.
 
     	 [bookmark: pgfId-3419252] Block creates a policy with the Block default action.
 
     	 [bookmark: pgfId-3419253] Block with reset creates a policy with the Block with reset default action.
 
    
 
    [bookmark: pgfId-3433223]After you create the SSL policy, you can modify the default action. For guidance on choosing a default action, see Setting Default Handling and Inspection for Encrypted Traffic.
 
    [bookmark: pgfId-3433393]The new SSL policy also contains default actions for traffic the system cannot decrypt: either it inherits the default action you just selected for undecryptable traffic, blocks it, or does not decrypt the traffic and inspects it with access control. You can modify the undecryptable traffic actions after you create the SSL policy. For guidance on selecting undecryptable traffic actions, see Setting Default Handling for Undecryptable Traffic
 
    [bookmark: pgfId-3420194]On the SSL policy page (Policies > SSL) you can view all your current SSL policies by name with optional description. Options on this page allow you to compare policies, create a new policy, copy a policy, view a report that lists all of the most recently saved settings in each policy, edit a policy, or delete a policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-3420197]Tip You can export SSL policies to, and import SSL policies from, other Defense Centers in your deployment. See Importing and Exporting Configurations for more information.
 
     
     
 
    
 
    
 
     
     Editing an SSL Policy 
     
 
     Editing an SSL Policy 
     
 
     Generating a Report of Current Traffic Decryption Settings 
     
 
     
 
      
       
       [bookmark: pgfId-3420209]Table 20-1 [bookmark: 22107]SSL Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-3420213]To... 
         
  
        	 
          
          [bookmark: pgfId-3420215]You can... 
         
  
       
 
        
        	[bookmark: pgfId-3420217]create a new SSL policy
  
        	[bookmark: pgfId-3420219]click New Policy. See Creating a Basic SSL Policy for more information.
  
       
 
        
        	[bookmark: pgfId-3420221]modify the settings in an existing SSL policy
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-3420228]compare SSL policies
  
        	[bookmark: pgfId-3420230]click Compare Policies. See Comparing SSL Policies for more information.
  
       
 
        
        	[bookmark: pgfId-3420232]copy an SSL policy
  ). See for more information on editing a copied policy. 
       
 
        
        	[bookmark: pgfId-3420239]view a PDF report that lists the current configuration settings in an SSL policy
  ). See for more information. 
       
 
        
        	[bookmark: pgfId-3420246]delete an SSL policy
  . When prompted whether to continue, you are also informed if another user has unsaved changes in the policy. 
       
 
       
     
 
    
 
    [bookmark: pgfId-3415263]To create an SSL policy:
 
    [bookmark: pgfId-3406380]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-3406394]Step 1 Select Policies > SSL.
 
    [bookmark: pgfId-3406650]The SSL Policy page appears.
 
    [bookmark: pgfId-3406696]Step 2 Click New Policy. 
 
    [bookmark: pgfId-3409381]The New SSL Policy pop-up window appears.
 
    [bookmark: pgfId-3409385]Step 3 Give the policy a unique Name and, optionally, a Description.
 
    [bookmark: pgfId-3406985]You can use all printable characters, including spaces and special characters.
 
    [bookmark: pgfId-3406991]Step 4 Specify the Default Action.
 
    [bookmark: pgfId-3407805]Note that you can modify your selected default action after you create your SSL policy. See Setting Default Handling and Inspection for Encrypted Traffic for more information.
 
    [bookmark: pgfId-3407072]Step 5 Click Save.
 
    [bookmark: pgfId-3419693]The SSL Policy Editor page appears. See Editing an SSL Policy for more information.
 
    [bookmark: pgfId-3452717]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3420286][bookmark: 69473]Setting Default Handling and Inspection for Encrypted Traffic
 
     [bookmark: pgfId-3420345]License: Any
 
     [bookmark: pgfId-3421709]Supported Devices: Series 3
 
     [bookmark: pgfId-3420379]The default action for an SSL policy determines how the system handles decryptable encrypted traffic that does not match any non-Monitor rule in the policy. When you apply an SSL policy that does not contain any SSL rules, the default action determines how all decryptable traffic on your network is handled. See Setting Default Handling for Undecryptable Traffic for more information on how the system handles undecryptable encrypted traffic. 
 
     [bookmark: pgfId-3420383]The following table lists the default actions you can choose, as well as their effect on encrypted traffic. Note that the system does not perform any kind of inspection on encrypted traffic blocked by the default action.
 
     [bookmark: pgfId-3420426]:
 
      
       
        
        [bookmark: pgfId-3420777]Table 20-2 [bookmark: 54105]SSL Policy Default Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3420781]Default Action 
          
  
         	 
           
           [bookmark: pgfId-3420783]Effect on Encrypted Traffic 
          
  
        
 
         
         	[bookmark: pgfId-3420789]Block
  
         	[bookmark: pgfId-3420791]block the SSL session without further inspection
  
        
 
         
         	[bookmark: pgfId-3420793]Block with reset
  
         	[bookmark: pgfId-3420795]block the SSL session without further inspection and reset the TCP connection
  
        
 
         
         	[bookmark: pgfId-3421110]Do not decrypt
  
         	[bookmark: pgfId-3421112]inspect the encrypted traffic with access control
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3428557]When you first create an SSL policy, logging connections that are handled by the default action is disabled by default. You can change this, as well as the default action itself, after you create the policy.
 
     [bookmark: pgfId-3420456]The following procedure explains how to set the default action for an SSL policy while editing the policy. See Editing an SSL Policy for the complete procedure for editing an SSL policy.
 
     [bookmark: pgfId-3420460]To set the default action of an SSL policy:
 
     [bookmark: pgfId-3420461]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3420462]Step 1 Select Policies > SSL.
 
     [bookmark: pgfId-3420463]The SSL policy page appears.
 ) next to the SSL policy you want to configure. 
     
 
     [bookmark: pgfId-3420468]The SSL policy editor appears.
 
     [bookmark: pgfId-3420469]Step 3 Select a Default Action. See the SSL Policy Default Actions table for more information.
 
     [bookmark: pgfId-3420485]Step 4 Configure logging options for the default action as described in Logging Decryptable Connections with SSL Rules.
 
     [bookmark: pgfId-3455679]Step 5 Click Save.
 
     [bookmark: pgfId-3455683]The SSL Policy Editor page appears. See Editing an SSL Policy for more information.
 
     [bookmark: pgfId-3452738]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3432812][bookmark: 62601]Setting Default Handling for [bookmark: marker-3432811]Undecryptable Traffic
 
     [bookmark: pgfId-3432816]License: Any
 
     [bookmark: pgfId-3432820]Supported Devices: Series 3
 
     [bookmark: pgfId-3439057]You can set undecryptable traffic actions at the SSL policy level to handle certain types of encrypted traffic the system cannot decrypt or inspect. When you apply an SSL policy that does not contain any SSL rules, the undecryptable traffic actions determine how all undecryptable encrypted traffic on your network is handled. 
 
     [bookmark: pgfId-3439058]Depending on the type of undecryptable traffic, you can choose to: 
 
      
      	 [bookmark: pgfId-3432830]block the connection
 
      	 [bookmark: pgfId-3432831]block the connection, then reset it
 
      	 [bookmark: pgfId-3432832]inspect the encrypted traffic with access control
 
      	 [bookmark: pgfId-3432833]inherit the default action from the SSL policy
 
     
 
      
       
        
        [bookmark: pgfId-3432840]Table 20-3 Undecryptable Traffic Types
 
        
        
         
         	 
           
           [bookmark: pgfId-3432848]Type 
          
  
         	 
           
           [bookmark: pgfId-3432850]Description 
          
  
         	 
           
           [bookmark: pgfId-3432852]Default Action 
          
  
         	 
           
           [bookmark: pgfId-3432854]Available Actions 
          
  
        
 
         
         	[bookmark: pgfId-3432856]Compressed Session
  
         	[bookmark: pgfId-3432858]The SSL session applies a data compression method.
  
         	[bookmark: pgfId-3432860]Inherit default action
  
         	[bookmark: pgfId-3432862]Do not decrypt
 [bookmark: pgfId-3455777]Block
 [bookmark: pgfId-3455780]Block with reset
 [bookmark: pgfId-3455803]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432864]SSLv2 Session
  
         	[bookmark: pgfId-3432866]The session is encrypted with SSL version 2.
 [bookmark: pgfId-3432867]Note that traffic is decryptable if the client hello message is SSL 2.0, and the remainder of the transmitted traffic is SSL 3.0. 
  
         	[bookmark: pgfId-3432869]Inherit default action
  
         	[bookmark: pgfId-3432871]Do not decrypt
 [bookmark: pgfId-3455806]Block
 [bookmark: pgfId-3455809]Block with reset
 [bookmark: pgfId-3455812]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432873]Unknown Cipher Suite
  
         	[bookmark: pgfId-3432875]The system does not recognize the cipher suite.
  
         	[bookmark: pgfId-3432877]Inherit default action
  
         	[bookmark: pgfId-3432879]Do not decrypt
 [bookmark: pgfId-3455815]Block
 [bookmark: pgfId-3455818]Block with reset
 [bookmark: pgfId-3455821]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432881]Unsupported Cipher Suite
  
         	[bookmark: pgfId-3432883]The system does not support decryption based on the detected cipher suite.
  
         	[bookmark: pgfId-3432885]Inherit default action
  
         	[bookmark: pgfId-3432887]Do not decrypt
 [bookmark: pgfId-3455845]Block
 [bookmark: pgfId-3455856]Block with reset
 [bookmark: pgfId-3455863]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432889]Session not cached
  
         	[bookmark: pgfId-3432891]The SSL session has session reuse enabled, the client and server reestablished the session with the session identifier, and the system did not cache that session identifier.
  
         	[bookmark: pgfId-3432893]Inherit default action
  
         	[bookmark: pgfId-3432895]Do not decrypt
 [bookmark: pgfId-3455870]Block
 [bookmark: pgfId-3455877]Block with reset
 [bookmark: pgfId-3455884]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3432905]Handshake Errors
  
         	[bookmark: pgfId-3432907]An error occurred during SSL handshake negotiation.
  
         	[bookmark: pgfId-3432909]Inherit default action
  
         	[bookmark: pgfId-3462975]Do not decrypt
 [bookmark: pgfId-3462976]Block
 [bookmark: pgfId-3462977]Block with reset
 [bookmark: pgfId-3462978]Inherit default action
  
        
 
         
         	[bookmark: pgfId-3460935]Decryption Errors
  
         	[bookmark: pgfId-3460937]An error occurred during traffic decryption.
  
         	[bookmark: pgfId-3460939]Block
  
         	[bookmark: pgfId-3460941]Block
 [bookmark: pgfId-3461056]Block with Reset
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3432913]When you first create an SSL policy, logging connections that are handled by the default action is disabled by default. Because the logging settings for the default action also apply to undecryptable traffic handling, logging connections handled by the undecryptable traffic actions is disabled by default. For more information on configuring default logging, see Logging Decryptable Connections with SSL Rules.
 
      
       
     
 
     
 
     [bookmark: pgfId-3464123]Note The system cannot decrypt traffic if an HTTP proxy is positioned between a client and your managed device, and the client and server establish a tunneled SSL connection using the CONNECT HTTP method. The Handshake Errors undecryptable action determines how the system handles this traffic. See Decrypt Actions: Decrypting Traffic for Further Inspection for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3471719]Note that if your browser uses certificate pinning to verify a server certificate, you cannot decrypt this traffic by re-signing the server certificate. Because you can still inspect this traffic with access control, it is not handled by the undecryptable traffic actions. If you want to allow this traffic, configure an SSL rule with the Do not decrypt action to match the server certificate common name or distinguished name.
 
     [bookmark: pgfId-3432914]To set the default handling for undecryptable traffic:
 
     [bookmark: pgfId-3432915]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3432916]Step 1 Select Policies > SSL.
 
     [bookmark: pgfId-3432917]The SSL Policy page appears.
 ) next to the SSL policy you want to configure. 
     
 
     [bookmark: pgfId-3432922]The SSL policy editor appears.
 
     [bookmark: pgfId-3432923]Step 3 Select the Undecryptable Actions tab. 
 
     [bookmark: pgfId-3432924]The Undecryptable Actions tab appears.
 
     [bookmark: pgfId-3432925]Step 4 For each field, select the action you want to take on the type of undecryptable traffic, or if you want to apply the SSL policy’s default action. See the SSL Policy Default Actions table for more information.
 
     [bookmark: pgfId-3432926]Step 5 Click Save to save your changes.
 
     [bookmark: pgfId-3432927]You must apply the associated access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3452758]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3405727][bookmark: 74144]Editing an SSL [bookmark: marker-3419127]Policy
 
    [bookmark: pgfId-3405571]License: Any
 
    [bookmark: pgfId-3421771]Supported Devices: Series 3
 
    [bookmark: pgfId-3419294]On the SSL policy editor, you can configure your policy and organize SSL rules. To configure an SSL policy, you must give the policy a unique name and specify a default action. You can also:
 
     
     	 [bookmark: pgfId-3419306]add, edit, delete, enable, and disable SSL rules
 
     	 [bookmark: pgfId-3419307]add trusted CA certificates
 
     	 [bookmark: pgfId-3419308]determine the handling for encrypted traffic the system cannot decrypt
 
     	 [bookmark: pgfId-3419309]log traffic that is handled by the default action and undecryptable traffic actions
 
    
 
    [bookmark: pgfId-3419310]After you create or modify an SSL policy, you can associate it with an access control policy, then apply the access control policy. You can also create custom user roles that allow you to assign different permissions to different users for configuring, organizing, and applying policies.
 
     
     Understanding and Creating SSL Rules 
     
 
     
 
      
       
       [bookmark: pgfId-3419318]Table 20-4 [bookmark: 51002]SSL Policy Configuration Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-3419322]To... 
         
  
        	 
          
          [bookmark: pgfId-3419324]You can... 
         
  
       
 
        
        	[bookmark: pgfId-3419326]modify the policy name or description
  
        	[bookmark: pgfId-3419328]click the name or description field, delete any characters as needed, then type the new name or description.
  
       
 
        
        	[bookmark: pgfId-3419330]set the default action
  
        	[bookmark: pgfId-3419335]find more information at Setting Default Handling and Inspection for Encrypted Traffic.
  
       
 
        
        	[bookmark: pgfId-3439501]set default handling for undecryptable traffic
  
        	[bookmark: pgfId-3439505]find more information at Setting Default Handling for Undecryptable Traffic.
  
       
 
        
        	[bookmark: pgfId-3419337]log connections for the default action and undecryptable traffic actions
  
        	[bookmark: pgfId-3419341]find more information at Logging Decryptable Connections with SSL Rules.
  
       
 
        
        	[bookmark: pgfId-3439516]add trusted CA certificates
  
        	[bookmark: pgfId-3439520]find more information at Trusting External Certificate Authorities.
  
       
 
        
        	[bookmark: pgfId-3419344]assign different rights to different users
  
        	[bookmark: pgfId-3419348]find more information at Managing Your SSL Inspection Deployment with Custom User Roles.
  
       
 
        
        	[bookmark: pgfId-3419351]save your policy changes
  
        	[bookmark: pgfId-3419353]click Save.
  
       
 
        
        	[bookmark: pgfId-3419355]cancel your policy changes
  
        	[bookmark: pgfId-3419357]click Cancel, then, if you have made changes, click OK.
  
       
 
        
        	[bookmark: pgfId-3419359]add a rule to a policy
  
        	[bookmark: pgfId-3419363]click Add Rule. See Understanding and Creating SSL Rules for more information.
 .  
       
 
        
        	[bookmark: pgfId-3419367]edit an existing rule
  ) next to the rule. See for more information. . 
       
 
        
        	[bookmark: pgfId-3419378]delete a rule
  . to delete one or more selected rules. 
       
 
        
        	[bookmark: pgfId-3419386]enable or disable an existing rule
  
        	[bookmark: pgfId-3419388]right-click a selected rule, select State, then select Disable or Enable. Disabled rules are grayed and marked (disabled) beneath the rule name.
  
       
 
        
        	[bookmark: pgfId-3419390]display the configuration page for a specific rule attribute
  
        	[bookmark: pgfId-3419392]click the name, value, or icon in the column for the condition on the row for the rule. For example, click the name or value in the Source Networks column to display the Networks page for the selected rule. See Tuning Traffic Decryption Using SSL Rules for more information.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3420019]When you change your configuration, a message indicates that you have unsaved changes. To retain your changes, you must save the policy before exiting the policy editor. If you attempt to exit the policy editor without saving your changes, you are cautioned that you have unsaved changes; you can then discard your changes and exit the policy, or return to the policy editor.
 
    [bookmark: pgfId-3420020]To protect the privacy of your session, after sixty minutes of inactivity on the policy editor, changes to your policy are discarded and you are returned to the SSL Policy page. After the first thirty minutes of inactivity, a message appears and updates periodically to provide the number of minutes remaining before changes are discarded. Any activity on the page cancels the timer.
 
    [bookmark: pgfId-3420021]When you attempt to edit the same policy in two browser windows, you are prompted whether to resume your edit in the new window, discard your changes in the original window and continue editing in the new window, or cancel the second window and return to the policy editor.
 
    [bookmark: pgfId-3420022]When multiple users edit the same policy concurrently, a message on the policy editor identifies other users who have unsaved changes. Any user who attempts to save changes is cautioned that his changes will overwrite changes by other users. When the same policy is saved by multiple users, the last saved changes are retained.
 
    [bookmark: pgfId-3419405]To edit an SSL policy:
 
    [bookmark: pgfId-3419406]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-3419407]Step 1 Select Policies > SSL.
 
    [bookmark: pgfId-3419408]The SSL Policy page appears.
 ) next to the SSL policy you want to configure. 
    
 
    [bookmark: pgfId-3419413]The SSL policy editor page appears.
 
    [bookmark: pgfId-3419414]Step 3 You have the following choices:
 
     
      
      	 [bookmark: pgfId-3419417]To configure your policy, you can take any of the actions summarized in the  SSL Policy Configuration Actions  table. 
 
      	 [bookmark: pgfId-3419424]To organize rules in your policy, you can take any of the actions described in Managing SSL Rules in a Policy.
 
     
 
    
 
    [bookmark: pgfId-3419429]Step 4 Save or discard your configuration. You have the following choices:
 
     
      
      	 [bookmark: pgfId-3419430]To save your changes and continue editing, click  Save. 
 
      	 [bookmark: pgfId-3419431]To discard your changes, click  Cancel and, if prompted, click  OK .
 
     
 
    
 
    [bookmark: pgfId-3419432]Your changes are discarded and the SSL Policy page appears. 
 
    [bookmark: pgfId-3452774]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3429950][bookmark: 93135]Applying [bookmark: marker-3429949]Decryption Settings Using Access Control
 
    [bookmark: pgfId-3429954]License: Any
 
    [bookmark: pgfId-3429958]Supported Devices: Series 3
 
    [bookmark: pgfId-3429964]After making any changes to an SSL policy, you must apply the access control policy it is associated with. For more information, see Applying an Access Control Policy.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-3472261] 
     Caution Associating an SSL policy with an access control policy, or subsequently dissociating the policy by selecting 
     None, restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-3429965]Keep the following points in mind when applying SSL policies:
 
     
     	 [bookmark: pgfId-3429966]You cannot delete an SSL policy that has been applied or is currently applying.
 
     	 [bookmark: pgfId-3472223]Applying an access control policy automatically applies the associated SSL policy. You cannot apply an SSL policy independently.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-3472224]Note In a passive deployment, the system cannot influence the flow of traffic. If you attempt to apply an access control policy that references an SSL policy that blocks encrypted traffic, or that is configured to decrypt traffic by re-signing the server certificate, the system displays a warning. Also, passive deployments do not support decrypting traffic encrypted with the ephemeral Diffie-Hellman (DHE) or the elliptic curve Diffie-Hellman (ECDHE) cipher suites. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3429972]To associate an SSL policy with an access control policy:
 
    [bookmark: pgfId-3463778]Access: Admin/Security Approver
 
    
 
    [bookmark: pgfId-3463779]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-3463780]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-3429980]The access control policy editor appears.
 
    [bookmark: pgfId-3429981]Step 3 Select the Advanced tab. 
 
    [bookmark: pgfId-3429982]Advanced settings for the access control policy appear. 
 ) next to General Settings. 
    
 
    [bookmark: pgfId-3429987]The General Settings pop-up window appears.
 
    [bookmark: pgfId-3429988]Step 5 Select an SSL policy from the SSL Policy to use for inspecting encrypted connections drop-down.
 
    [bookmark: pgfId-3429989]Step 6 Click OK.
 
    [bookmark: pgfId-3429990]Advanced settings for the access control policy appear.
 
    [bookmark: pgfId-3456093]Step 7 Click Save to save your changes.
 
    [bookmark: pgfId-3457042]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-3452801]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3456137][bookmark: 88882]Generating a [bookmark: marker-3456136]Report of Current Traffic Decryption Settings
 
    [bookmark: pgfId-3456141]License: Any
 
    [bookmark: pgfId-3412361]An SSL policy report is a record of the policy and rules configuration at a specific point in time. You can use the report for auditing purposes or to inspect the current configuration.
 
     
      
    
 
    
 
    [bookmark: pgfId-3412362]Tip You can also generate an SSL comparison report that compares a policy with the currently applied policy or with another policy. For more information, see Comparing SSL Policies.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-3412372]Table 20-5 SSL Policy Report Sections 
 
       
       
        
        	 
          
          [bookmark: pgfId-3412376]Section 
         
  
        	 
          
          [bookmark: pgfId-3412378]Description 
         
  
       
 
        
        	[bookmark: pgfId-3412380]Title Page
  
        	[bookmark: pgfId-3412382]Identifies the name of the policy report, the date and time the policy was last modified, and the name of the user who made that modification.
  
       
 
        
        	[bookmark: pgfId-3412384]Table of Contents
  
        	[bookmark: pgfId-3412386]Describes the contents of the report.
  
       
 
        
        	[bookmark: pgfId-3412388]Policy Information
  
        	[bookmark: pgfId-3412390]Provides the name and description of the policy, the name of the user who last modified the policy, and the date and time the policy was last modified.
  
       
 
        
        	[bookmark: pgfId-3412395]Default Action
  
        	[bookmark: pgfId-3412399]Provides the default action.
  
       
 
        
        	[bookmark: pgfId-3412402]Default Logging
  
        	[bookmark: pgfId-3412404]Provides the default connection logging settings.
  
       
 
        
        	[bookmark: pgfId-3412409]Rules
  
        	[bookmark: pgfId-3412411]Provides the rule action and conditions for each rule in the policy, by rule category.
  
       
 
        
        	[bookmark: pgfId-3412419]Trusted CA Certificates
  
        	[bookmark: pgfId-3412421]Provides the CA certificates that are automatically trusted if detected traffic is encrypted using these certificates or other certificates within the chain of trust.
  
       
 
        
        	[bookmark: pgfId-3412426]Undecryptable Actions
  
        	[bookmark: pgfId-3412428]Provides the action taken on detected types of traffic that cannot be decrypted.
  
       
 
        
        	[bookmark: pgfId-3412433]Referenced Objects
  
        	[bookmark: pgfId-3412435]Provides the name and configuration of all individual objects and group objects used in the policy, by type of condition (networks, VLAN tags, and so on) where the object is configured. 
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3412443]To view an SSL policy report:
 
    [bookmark: pgfId-3412444]Access: Admin/Access Admin/Network Admin/Security Approver
 
    
 
    [bookmark: pgfId-3412445]Step 1 Select Policies > SSL.
 
    [bookmark: pgfId-3412446]The SSL Policy page appears.
 ) next to the policy for which you want to generate a report. Remember to save any changes before you generate an SSL policy report; only saved changes appear in the report. 
    
 
    [bookmark: pgfId-3412451]The system generates the report. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
    [bookmark: pgfId-3452859]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3412453][bookmark: 90844]Comparing SSL [bookmark: marker-3419140]Policies
 
    [bookmark: pgfId-3456236]License: Any
 
    [bookmark: pgfId-3412457]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between two SSL policies. You can compare any two policies or the currently applied policy with another policy. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies.
 
    [bookmark: pgfId-3412458]There are two tools you can use to compare policies:
 
     
     	 [bookmark: pgfId-3412459]The comparison view displays only the differences between two policies in a side-by-side format. The name of each policy appears in the title bar on the left and right sides of the comparison view except when you select  Running Configuration , in which case a blank bar represents the currently active policy.
 
    
 
    [bookmark: pgfId-3412460]You can use this to view and navigate both policies on the web interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-3412461]The comparison report creates a record of only the differences between two policies in a format similar to the policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-3412462]You can use this to save, copy, print, and share your policy comparisons for further examination.
 
    [bookmark: pgfId-3412463]For more information on understanding and using the policy comparison tools, see:
 
     
     	 [bookmark: pgfId-3412467]Using the SSL Policy Comparison View
 
     	 [bookmark: pgfId-3412471]Using the SSL Policy Comparison Report
 
    
 
     
      [bookmark: pgfId-3412473][bookmark: 29486]Using the SSL Policy Comparison View
 
     [bookmark: pgfId-3456277]License: Any
 
     [bookmark: pgfId-3412475]The comparison view displays both policies in a side-by-side format, with each policy identified by name in the title bar on the left and right sides of the comparison view. When comparing two policies other than the running configuration, the time of last modification and the last user to modify are displayed with the policy name. Differences between the two policies are highlighted:
 
      
      	 [bookmark: pgfId-3412476]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-3412477]Green indicates that the highlighted setting appears in one policy but not the other.
 
     
 
      
       
        
        [bookmark: pgfId-3412484]Table 20-6 SSL Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3412488]To... 
          
  
         	 
           
           [bookmark: pgfId-3412490]You can... 
          
  
        
 
         
         	[bookmark: pgfId-3412492]navigate individually through changes
  
         	[bookmark: pgfId-3412494]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-3412500]generate a new policy comparison view
  
         	[bookmark: pgfId-3412502]click New Comparison.
 [bookmark: pgfId-3412503]The Select Comparison window appears. See Using the SSL Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-3412508]generate a policy comparison report
  
         	[bookmark: pgfId-3412510]click Comparison Report. 
 [bookmark: pgfId-3412511]The policy comparison report creates a PDF document that lists only the differences between the two policies.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3412515][bookmark: 14990]Using the SSL Policy Comparison Report
 
     [bookmark: pgfId-3456303]License: Any
 
     [bookmark: pgfId-3412518]An SSL policy comparison report is a record of all differences between two SSL policies or a policy and the currently applied policy identified by the policy comparison view, presented in PDF format. You can use this report to further examine the differences between two policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-3412519]You can generate an SSL policy comparison report from the comparison view for any policies to which you have access. Remember to save any changes before you generate a policy report; only saved changes appear in the report.
 
     [bookmark: pgfId-3412520]The format of the policy comparison report is the same as the policy report with one exception: the policy report contains all configurations in the policy, and the policy comparison report lists only those configurations that differ between the policies. An SSL policy comparison report contains the sections described in Generating a Report of Current Traffic Decryption Settings. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3412524]Tip You can use a similar procedure to compare access control, network analysis, intrusion, file, system, or health policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3412525]To compare two SSL policies:
 
     [bookmark: pgfId-3412526]Access: Admin/Access Admin/Network Admin/Security Approver
 
     
 
     [bookmark: pgfId-3412527]Step 1 Select Policies > SSL.
 
     [bookmark: pgfId-3412528]The SSL Policy appears.
 
     [bookmark: pgfId-3412529]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-3412530]The Select Comparison window appears.
 
     [bookmark: pgfId-3412531]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-3412532]To compare two different policies, select  Other Policy .
 
      
 
     
 
     [bookmark: pgfId-3412533]The page refreshes and the Policy A and Policy B drop-down lists appear.
 
      
       
       	 [bookmark: pgfId-3412534]To compare another policy to the currently active policy, select  Running Configuration. 
 
      
 
     
 
     [bookmark: pgfId-3412535]The page refreshes and the Target/Running Configuration A and Policy B drop-down lists appear.
 
     [bookmark: pgfId-3412536]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-3412537]If you are comparing two different policies, select the policies you want to compare from the Policy A and Policy B drop-down lists.
 
       	 [bookmark: pgfId-3412538]If you are comparing the running configuration to another policy, select the second policy from the Policy B drop-down list.
 
      
 
     
 
     [bookmark: pgfId-3412539]Step 5 Click OK to display the policy comparison view.
 
     [bookmark: pgfId-3412540]The comparison view appears.
 
     [bookmark: pgfId-3412541]Step 6 Optionally, click Comparison Report to generate the SSL policy comparison report. 
 
     [bookmark: pgfId-3412542]The SSL policy comparison report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
     [bookmark: pgfId-3452886]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3351539]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3535792][bookmark: 68255]Getting Started with SSL Rules 
      
      
 
     
 
 
    [bookmark: pgfId-3535795]Within an SSL policy, SSL rules provide a granular method of handling encrypted traffic across multiple managed devices, whether blocking the traffic without further inspection, not decrypting the traffic and inspecting it with access control, or decrypting the traffic for access control analysis.
 
    [bookmark: pgfId-3535743]The system matches traffic to SSL rules in the order you specify. In most cases, the system handles encrypted traffic according to the first SSL rule where all the rule’s conditions match the traffic. Conditions can be simple or complex; you can control traffic by security zone, network or geographical location, VLAN, port, application, requested URL, user, certificate, certificate distinguished name, certificate status, cipher suite, or encryption protocol version.
 
    [bookmark: pgfId-3535744]Each rule also has an action, which determines whether you monitor, block, or inspect matching traffic with access control, optionally after decrypting matching traffic. Note that the system does not further inspect encrypted traffic it blocks. It does inspect encrypted and undecryptable traffic with access control. However, some access control rule conditions require unencrypted traffic, so encrypted traffic may match fewer rules. Also, by default, the system disables intrusion and file inspection of encrypted payloads. 
 
    [bookmark: pgfId-3535745]The following scenario summarizes the ways that SSL rules handle traffic in an inline deployment.
 
    [bookmark: pgfId-3549940]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3501332]In this scenario, traffic is evaluated as follows:
 
     
     	 [bookmark: pgfId-3501333] Undecryptable Traffic Action  evaluates encrypted traffic first. For traffic the system cannot decrypt, the system either blocks it without further inspection or passes it for access control inspection. Encrypted traffic that does not match continues to the next rule.
 
     	 [bookmark: pgfId-3501334] SSL Rule 1: Monitor evaluates encrypted traffic next. Monitor rules track and log encrypted traffic but do not affect traffic flow. The system continues to match traffic against additional rules to determine whether to permit or deny it.
 
     	 [bookmark: pgfId-3500627] SSL Rule 2: Do Not Decrypt  evaluates encrypted traffic third. Matching traffic is not decrypted; the system inspects this traffic with access control, but not file or intrusion inspection. Traffic that does not match continues to the next rule.
 
     	 [bookmark: pgfId-3500628] SSL Rule 3: Block evaluates encrypted traffic fourth. Matching traffic is blocked without further inspection. Traffic that does not match continues to the next rule.
 
     	 [bookmark: pgfId-3500629] SSL Rule 4: Decrypt - Known Key  evaluates encrypted traffic fifth. Matching traffic incoming to your network is decrypted using a private key you upload. The decrypted traffic is then evaluated against access control rules. Access control rules handle decrypted and unencrypted traffic identically. The system can block traffic as a result of this additional inspection. All remaining traffic is reencrypted before being allowed to the destination. Traffic that does not match the SSL rule continues to the next rule. 
 
     	 [bookmark: pgfId-3501953] SSL Rule 5: Decrypt - Resign  is the final rule. If traffic matches this rule, the system re-signs the server certificate with an uploaded CA certificate, then acts as a man-in-the-middle to decrypt traffic. The decrypted traffic is then evaluated against access control rules. Access control rules treat decrypted and unencrypted traffic identically. The system can block traffic as a result of this additional inspection. All remaining traffic is reencrypted before being allowed to the destination. Traffic that does not match the SSL rule continues to the next rule.
 
     	 [bookmark: pgfId-3503003] SSL Policy Default Action handles all traffic that does not match any of the SSL rules. The default action either blocks encrypted traffic without further inspection or does not decrypt it, passing it for access control inspection. 
 
    
 
    [bookmark: pgfId-3432068]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3499593]Configuring Supporting Inspection Information
 
     	 [bookmark: pgfId-3405330]Understanding and Creating SSL Rules
 
     	 [bookmark: pgfId-3405631]Managing SSL Rules in a Policy
 
    
 
   
 
    
     [bookmark: pgfId-3499171][bookmark: 14361][bookmark: 92939]Configuring Supporting Inspection Information
 
    [bookmark: pgfId-3505538]License: Any
 
    [bookmark: pgfId-3475921]You must create reusable public key infrastructure (PKI) objects to control encrypted traffic based on encrypted session characteristics and decrypt encrypted traffic. You can add this information on the fly when uploading trusted certificate authority (CA) certificates to the SSL policy and creating SSL rule conditions, creating the associated object in the process. However, configuring these objects ahead of time reduces the chance of improper object creation. 
 
    [bookmark: pgfId-3475922]Decrypting Encrypted Traffic with Certificates and Paired Keys
 
    [bookmark: pgfId-3475923]The system can decrypt incoming encrypted traffic if you configure an internal certificate object by uploading the server certificate and private key used to encrypt the session. If you reference that object in an SSL rule with an action of Decrypt - Known Key and traffic matches that rule, the system uses the uploaded private key to decrypt the session. 
 
    [bookmark: pgfId-3475924]The system can also decrypt outgoing traffic if you configure an internal CA object by uploading a CA certificate and private key. If you reference that object in an SSL rule with an action of Decrypt - Resign and traffic matches that rule, the system re-signs the server certificate passed to the client browser, then acts as a man-in-the-middle to decrypt the session. 
 
    [bookmark: pgfId-3475925]See the following for more information:
 
     
     	 [bookmark: pgfId-3475929]Working with Internal Certificate Objects
 
     	 [bookmark: pgfId-3475933]Working with Internal Certificate Authority Objects
 
    
 
    [bookmark: pgfId-3475934]Controlling Traffic Based on Encrypted Session Characteristics
 
     
      
       
        
        	 
          
          [bookmark: pgfId-3504089]If you configure... 
         
  
        	 
          
          [bookmark: pgfId-3504091]You can control encrypted traffic based on whether... 
         
  
       
 
        
        	[bookmark: pgfId-3504093]a cipher suite list containing one or more cipher suites
  
        	[bookmark: pgfId-3504095]the cipher suite used to negotiate the encrypted session matches a cipher suite in the cipher suite list
  
       
 
        
        	[bookmark: pgfId-3504097]a trusted CA object by uploading a CA certificate your organization trusts
  
        	[bookmark: pgfId-3504099]the trusted CA trusts the server certificate used to encrypt the session, whether: 
 
          
          	 [bookmark: pgfId-3522238]the CA issued the certificate directly
 
          	 [bookmark: pgfId-3522245]the CA issued a certificate to an intermediate CA that issued the server certificate
 
         
  
       
 
        
        	[bookmark: pgfId-3504101]an external certificate object by uploading a server certificate
  
        	[bookmark: pgfId-3504103]the server certificate used to encrypt the session matches the uploaded server certificate
  
       
 
        
        	[bookmark: pgfId-3504105]a distinguished name object containing a certificate subject or issuer distinguished name
  
        	[bookmark: pgfId-3504107]the subject or issuer common name, country, organization, or organizational unit on the certificate used to encrypt the session matches the configured distinguished name
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3475962]See the following for more information:
 
     
     	 [bookmark: pgfId-3475966]Working with Cipher Suite Lists
 
     	 [bookmark: pgfId-3475970]Working with Trusted Certificate Authority Objects
 
     	 [bookmark: pgfId-3475974]Working with External Certificate Objects
 
     	 [bookmark: pgfId-3475978]Working with Distinguished Name Objects 
 
    
 
   
 
    
     [bookmark: pgfId-3405213][bookmark: 93402]Understanding and Creating SSL [bookmark: marker-3432470]Rules
 
    [bookmark: pgfId-3405341]License: Any
 
    [bookmark: pgfId-3433325]Supported Devices: Series 3
 
    [bookmark: pgfId-3482824]Within an SSL policy, SSL rules provide a granular method of handling network traffic across multiple managed devices. In addition to its unique name, each SSL rule has the following basic components. 
 
    [bookmark: pgfId-3482825]State
 
    [bookmark: pgfId-3482826]By default, rules are enabled. If you disable a rule, the system does not use it to evaluate network traffic, and stops generating warnings and errors for that rule.
 
    [bookmark: pgfId-3482827]Position
 
    [bookmark: pgfId-3482828]Rules in an SSL policy are numbered, starting at 1. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
    [bookmark: pgfId-3482829]Conditions
 
    [bookmark: pgfId-3482830]Conditions specify the specific traffic the rule handles. Conditions can match traffic by security zone, network or geographical location, VLAN, port, application, requested URL, user, certificate, certificate subject or issuer, certificate status, cipher suite, or encryption protocol version. Conditions can be simple or complex; their use can depends on target device licenses.
 
    [bookmark: pgfId-3482831]Action
 
    [bookmark: pgfId-3482832]A rule’s action determines how the system handles matching traffic. You can monitor, trust, block, or decrypt matching traffic. Decrypted traffic is subject to further inspection. Note that the system does not perform inspection on blocked or trusted encrypted traffic.
 
    [bookmark: pgfId-3482835]Logging
 
    [bookmark: pgfId-3482836]A rule’s logging settings govern the records the system keeps of the traffic it handles. You can keep a record of traffic that matches a rule. You can log a connection when the system blocks an encrypted session or allows it to pass uninspected, according to the settings in an SSL policy. You can also force the system to log connections that it decrypts for further evaluation by access control rules, regardless of how the system later handles or inspects the traffic. You can log connections to the Defense Center database, as well as to the system log (syslog) or to an SNMP trap server.
 
     
      
    
 
    
 
    [bookmark: pgfId-3482846]Tip Properly creating and ordering SSL rules is a complex task, but one that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules, require additional licenses, or contain invalid configurations. To help ensure that the system handles traffic as you expect, the SSL policy interface has a robust warning and error feedback system for rules. For more information, see Troubleshooting SSL Rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3482850]To create or modify an SSL rule:
 
    [bookmark: pgfId-3482854]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-3482855]Step 1 Select Policies > SSL.
 
    [bookmark: pgfId-3482856]The SSL Policy page appears.
 ) next to the SSL policy where you want to add a rule. 
    
 
    [bookmark: pgfId-3482861]The SSL policy editor appears, focused on the Rules tab.
 
    [bookmark: pgfId-3482862]Step 3 You have the following options:
 
     
      
      	 [bookmark: pgfId-3482863]To add a new rule, click  Add Rule .
 
      	 [bookmark: pgfId-3482867]To edit an existing rule, click the edit icon (
 
     
 
     [image: ] ) next to the rule you want to edit. 
    
 
    [bookmark: pgfId-3482868]The SSL rule editor appears.
 
    [bookmark: pgfId-3482869]Step 4 Type a Name for the rule.
 
    [bookmark: pgfId-3482870]Each rule must have a unique name. You can use up to thirty printable characters, including spaces and special characters, with the exception of the colon (:).
 
    [bookmark: pgfId-3482871]Step 5 Configure the rule components, as summarized above. You can configure the following, or accept the defaults:
 
     
      
      	 [bookmark: pgfId-3490691]Specify whether the rule is  Enabled .
 
      	 [bookmark: pgfId-3490692]Specify the rule position; see Specifying an SSL Rule’s Order of Evaluation.
 
      	 [bookmark: pgfId-3490695]Select a rule  Action ; see Using Rule Actions to Determine Encrypted Traffic Handling and Inspection.
 
      	 [bookmark: pgfId-3482883]Configure the rule’s conditions; see Using Conditions to Specify the Encrypted Traffic a Rule Handles.
 
      	 [bookmark: pgfId-3482891]Specify  Logging options; see Logging Decryptable Connections with SSL Rules.
 
     
 
    
 
    [bookmark: pgfId-3482897]Step 6 Click Save to save the rule.
 
    [bookmark: pgfId-3482901]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-3482905]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3485133][bookmark: 90432]Specifying an SSL Rule’s Order of Evaluation
 
     [bookmark: pgfId-3511235]License: Any
 
     [bookmark: pgfId-3522424]Supported Devices: Series 3
 
     [bookmark: pgfId-3485139]When you first create an SSL rule, you specify its position using the Insert drop-down list in the rule editor. SSL rules in an SSL policy are numbered, starting at 1. The system matches traffic to SSL rules in top-down order by ascending rule number. 
 
     [bookmark: pgfId-3485140]In most cases, the system handles network traffic according to the first SSL rule where all the rule’s conditions match the traffic. Except in the case of Monitor rules (which log traffic but do not affect traffic flow), the system does not continue to evaluate traffic against additional, lower-priority rules after that traffic matches a rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-3485729]Tip Proper SSL rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs. For more information, see Ordering SSL Rules to Improve Performance and Avoid Preemption.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3485141]In addition to ordering rules by number, you can group rules by category. By default the system provides three categories: Administrator, Standard, and Root. You can add custom categories, but you cannot delete the system-provided categories or change their order. For information on changing the position or category of an existing rule, see Changing an SSL Rule’s Position or Category.
 
     [bookmark: pgfId-3485143]To add a rule to a category while editing or creating a rule:
 
     [bookmark: pgfId-3485147]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3485148]Step 1 In the SSL rule editor, from the Insert drop-down list, select Into Category, then select the category you want to use.
 
     [bookmark: pgfId-3485149]When you save the rule, it is placed last in that category.
 
     [bookmark: pgfId-3485150]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3485151]To position a rule by number while editing or creating a rule:
 
     [bookmark: pgfId-3485155]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3485156]Step 1 In the SSL rule editor, from the Insert drop-down list, select above rule or below rule, then type the appropriate rule number.
 
     [bookmark: pgfId-3485157]When you save the rule, it is placed where you specified.
 
     [bookmark: pgfId-3485158]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3483556][bookmark: 31965][bookmark: 45259]Using Conditions to Specify the Encrypted Traffic a Rule Handles
 
     [bookmark: pgfId-3483955]License: feature dependent
 
     [bookmark: pgfId-3512108]Supported Devices: Series 3
 
     [bookmark: pgfId-3483566]An SSL rule’s conditions identify the type of encrypted traffic that rule handles. Conditions can be simple or complex, and you can specify more than one condition type per rule. Only if traffic meets all the conditions in a rule does the rule apply to the traffic.
 
     [bookmark: pgfId-3483567]If you do not configure a particular condition for a rule, the system does not match traffic based on that criterion. For example, a rule with a certificate condition but no version condition evaluates traffic based on the server certificate used to negotiate the session, regardless of the session SSL or TLS version.
 
      
       
        
        [bookmark: pgfId-3483574]Table 21-1 SSL Rule Condition Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-3483580]This Condition... 
          
  
         	 
           
           [bookmark: pgfId-3483582]Matches Encrypted Traffic... 
          
  
         	 
           
           [bookmark: pgfId-3483584]Details 
          
  
        
 
         
         	[bookmark: pgfId-3483586]Zones
  
         	[bookmark: pgfId-3483588]entering or leaving a device via an interface in a specific security zone
  
         	[bookmark: pgfId-3483590]A security zone is a logical grouping of one or more interfaces according to your deployment and security policies. Interfaces in a zone may be located across multiple devices. To build a zone condition, see Controlling Encrypted Traffic by Network Zone.
  
        
 
         
         	[bookmark: pgfId-3483595]Networks
  
         	[bookmark: pgfId-3483597]by its source or destination IP address, country, or continent
  
         	[bookmark: pgfId-3483599]You can explicitly specify IP addresses. The geolocation feature also allows you to control traffic based on its source or destination country or continent. To build a network condition, see Controlling Encrypted Traffic by Network or Geographical Location.
  
        
 
         
         	[bookmark: pgfId-3483604]VLAN Tags
  
         	[bookmark: pgfId-3483606]tagged by VLAN
  
         	[bookmark: pgfId-3483608]The system uses the innermost VLAN tag to identify a packet by VLAN. To build a VLAN connection, see Controlling Encrypted VLAN Traffic.
  
        
 
         
         	[bookmark: pgfId-3483613]Ports
  
         	[bookmark: pgfId-3483615]by its source or destination port
  
         	[bookmark: pgfId-3483617]You can control encrypted traffic based on the TCP port. To build a port condition, see Controlling Encrypted Traffic by Port.
  
        
 
         
         	[bookmark: pgfId-3483622]Users
  
         	[bookmark: pgfId-3483624]by the user involved in the session
  
         	[bookmark: pgfId-3483626]You can control encrypted traffic based on the LDAP user logged into a host involved in an encrypted, monitored session. You can control traffic based on individual users or groups retrieved from a Microsoft Active Directory server. To build a user condition, see Controlling Encrypted Traffic Based on User.
  
        
 
         
         	[bookmark: pgfId-3483631]Applications
  
         	[bookmark: pgfId-3483633]by the application detected in a session
  
         	[bookmark: pgfId-3483635]You can control access to individual applications in encrypted sessions, or filter access according to basic characteristics: type, risk, business relevance, and categories. To build an application condition, see Controlling Encrypted Traffic Based on Application.
  
        
 
         
         	[bookmark: pgfId-3483640]Categories
  
         	[bookmark: pgfId-3483642]by the URL requested in the session, based on the certificate subject distinguished name
  
         	[bookmark: pgfId-3483644]You can limit the websites that users on your network can access based on the URL’s general classification and risk level. To build a URL condition, see Controlling Encrypted Traffic by URL Category and Reputation.
 
           
            
          
 
          
 
           
           [bookmark: pgfId-3550441]Caution Adding or removing a URL category and reputation condition in an SSL rule restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
           How Snort Restarts Affect Traffic for more information. 
            
            
 
           
 
          
  
        
 
         
         	[bookmark: pgfId-3483649]Distinguished Names
  
         	[bookmark: pgfId-3483651]by the subject or issuer distinguished name of the server certificate used to negotiate the encrypted session
  
         	[bookmark: pgfId-3483653]You can control encrypted traffic based on the CA that issued a server certificate, or the server certificate holder. To build a distinguished name condition, see Controlling Encrypted Traffic by Certificate Distinguished Name.
  
        
 
         
         	[bookmark: pgfId-3483658]Certificates
  
         	[bookmark: pgfId-3483660]by the server certificate used to negotiate the encrypted session
  
         	[bookmark: pgfId-3483662]You can control encrypted traffic based on the server certificate passed to the user’s browser in order to negotiate the encrypted session. To build a certificate condition, see Controlling Encrypted Traffic by Certificate Status.
  
        
 
         
         	[bookmark: pgfId-3483667]Certificate Status
  
         	[bookmark: pgfId-3483669]by properties of the server certificate used to negotiate the encrypted session
  
         	[bookmark: pgfId-3483671]You can control encrypted traffic based on a server certificate’s status. To build a certificate status condition, see Controlling Encrypted Traffic by Certificate Status.
  
        
 
         
         	[bookmark: pgfId-3483676]Cipher Suites
  
         	[bookmark: pgfId-3483678]by the cipher suite used to negotiate the encrypted session
  
         	[bookmark: pgfId-3483680]You can control encrypted traffic based on the cipher suite selected by the server to negotiate the encrypted session. To build a cipher suite condition, see Controlling Encrypted Traffic by Cipher Suite.
  
        
 
         
         	[bookmark: pgfId-3483685]Versions
  
         	[bookmark: pgfId-3483687]by the version of SSL or TLS used to encrypt the session
  
         	[bookmark: pgfId-3483689]You can control encrypted traffic based on the version of SSL or TLS used to encrypt the session. To build a version condition, see Controlling Traffic by Encryption Protocol Version. 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3483703]Note that while you can control and inspect encrypted traffic with a Series 3 device, controlling traffic using detected application, URL category, or user requires additional licenses. Also, overly complex rules can consume excessive resources and in some cases prevent you from applying the policy. For more information, see Troubleshooting SSL Rules.
 
    
 
     
      [bookmark: pgfId-3482778][bookmark: 42634]Using Rule Actions to Determine Encrypted Traffic Handling and Inspection
 
     [bookmark: pgfId-3507109]License: Any
 
     [bookmark: pgfId-3507113]Supported Devices: Series 3
 
     [bookmark: pgfId-3476533]Every SSL rule has an associated action that determines the following for matching encrypted traffic:
 
      
      	 [bookmark: pgfId-3476534]handling — foremost, the rule action governs whether the system will monitor, trust, block, or decrypt encrypted traffic that matches the rule’s conditions
 
      	 [bookmark: pgfId-3525470]logging — the rule action determines when and how you can log details about matching encrypted traffic. 
 
     
 
     [bookmark: pgfId-3525471]Your SSL inspection configuration handles, inspects, and logs decrypted traffic:
 
      
      	 [bookmark: pgfId-3522651]The SSL policy’s undecryptable actions handle traffic that the system cannot decrypt; see Setting Default Handling for Undecryptable Traffic. 
 
      	 [bookmark: pgfId-3522658]The policy’s default action handles traffic that does not meet the condition of any non-Monitor SSL rule; see Setting Default Handling and Inspection for Encrypted Traffic. 
 
     
 
     [bookmark: pgfId-3525556]You can log a connection event when the system blocks or trusts an encrypted session. You can also force the system to log connections that it decrypts for further evaluation by access control rules, regardless of how the system later handles or inspects the traffic. Connection logs for encrypted sessions contain details about the encryption, such as the certificate used to encrypt that session. You can log only end-of-connection events, however: 
 
      
      	 [bookmark: pgfId-3525557]for blocked connections (Block, Block with reset), the system immediately ends the sessions and generates an event
 
      	 [bookmark: pgfId-3525558]for trusted connections (Do not decrypt), the system generates an event when the session ends
 
     
 
     [bookmark: pgfId-3525484]For detailed information on rule actions and how they affect handling and logging, see the following sections:
 
      
      	 [bookmark: pgfId-3515391]Monitor Action: Postponing Action and Ensuring Logging
 
      	 [bookmark: pgfId-3515405]Do Not Decrypt Action: Passing Encrypted Traffic Without Inspection
 
      	 [bookmark: pgfId-3515411]Blocking Actions: Blocking Encrypted Traffic Without Inspection
 
      	 [bookmark: pgfId-3515417]Decrypt Actions: Decrypting Traffic for Further Inspection
 
      	 [bookmark: pgfId-3515423]Managing SSL Rules in a Policy
 
     
 
    
 
     
      [bookmark: pgfId-3476537][bookmark: 45207]Monitor Action: Postponing Action and Ensuring Logging
 
     [bookmark: pgfId-3511274]License: Any
 
     [bookmark: pgfId-3522748]Supported Devices: Series 3
 
     [bookmark: pgfId-3476539]The Monitor action does not affect encrypted traffic flow; matching traffic is neither immediately permitted nor denied. Rather, traffic is matched against additional rules, if present, to determine whether to trust, block, or decrypt it. The first non-Monitor rule matched determines traffic flow and any further inspection. If there are no additional matching rules, the system uses the default action.
 
     [bookmark: pgfId-3511307]Because the primary purpose of Monitor rules is to track network traffic, the system automatically logs end-of connection events for monitored traffic. That is, the system always logs the end of the connection to the Defense Center database, regardless of the logging configuration of the rule or default action that later handles the connection. In other words, if a packet matches a Monitor rule, the connection is always logged, even if the packet matches no other rules and you do not enable logging on the default action.
 
    
 
     
      [bookmark: pgfId-3522873][bookmark: 22481]Do Not Decrypt Action: Passing Encrypted Traffic Without Inspection
 
     [bookmark: pgfId-3522880]License: Any
 
     [bookmark: pgfId-3522903]Supported Devices: Series 3
 
     [bookmark: pgfId-3537718]The Do not decrypt action passes encrypted traffic for evaluation by the access control policy’s rules and default action. Because some access control rule conditions require unencrypted traffic, this traffic may match fewer rules. The system cannot perform deep inspection on encrypted traffic, such as intrusion or file inspection.
 
    
 
     
      [bookmark: pgfId-3537724][bookmark: 59880]Blocking Actions: Blocking Encrypted Traffic Without Inspection
 
     [bookmark: pgfId-3537711]License: Any
 
     [bookmark: pgfId-3523020]Supported Devices: Series 3
 
     [bookmark: pgfId-3476549]The Block and Block with reset actions are analogous to the access control rule actions Block and Block with reset. These actions prevent the client and server from establishing the SSL-encrypted session and passing encrypted traffic. Block with reset rules also reset the connection. 
 
     [bookmark: pgfId-3533023]Note that the system does not display the configured response page for blocked encrypted traffic. Instead, users requesting prohibited URLs have their connection either reset or time out. See Displaying a Custom Web Page for Blocked URLs for more information.
 
      
       
     
 
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3476553][bookmark: 29589]Decrypt Actions: Decrypting Traffic for Further Inspection
 
    [bookmark: pgfId-3511057]License: Any
 
    [bookmark: pgfId-3523062]Supported Devices: Series 3
 
    [bookmark: pgfId-3476555]The Decrypt - Known Key and Decrypt - Resign actions decrypt encrypted traffic. The system inspects decrypted traffic with access control. Access control rules handle decrypted and unencrypted traffic identically — you can inspect it for discovery data as well as detect and block intrusions, prohibited files, and malware. The system reencrypts allowed traffic before passing it to its destination.
 
    [bookmark: pgfId-3507179]When you configure the Decrypt - Known Key action, you can associate one or more server certificates and paired private keys with the action. If traffic matches the rule, and the certificate used to encrypt the traffic matches the certificate associated with the action, the system uses the appropriate private key to obtain the session encryption and decryption keys. Because you must have access to the private key, this action is best suited to decrypt traffic incoming to servers your organization controls.
 
    [bookmark: pgfId-3507941]Similarly, you can associate one Certificate Authority certificate and private key with the Decrypt - Resign action. If traffic matches this rule, the system re-signs the server certificate with the CA certificate, then acts as a man-in-the-middle. It creates two SSL sessions, one between client and managed device, one between managed device and server. Each session contains different cryptographic session details, and allows the system to decrypt and reencrypt traffic. This action is more suited for outgoing traffic, as you replace the certificate’s private key with one you control to obtain the session keys.
 
    [bookmark: pgfId-3527974]Re-signing a server certificate involves either replacing the certificate’s public key with a CA certificate public key, or replacing the entire certificate. Normally, if you replace an entire server certificate, the client browser warns the certificate is not signed by a trusted authority when establishing the SSL connection. However, if your client’s browser trusts the CA in the policy, the browser does not warn that the certificate is not trusted. If the original server certificate is self-signed, the system replaces the entire certificate, and trusts the re-signing CA, but the user’s browser does not warn that the certificate is self-signed. In this case, replacing only the server certificate public key causes the client browser does warn that the certficate is self-signed.
 
    [bookmark: pgfId-3528117]If you configure a rule with the Decrypt - Resign action, the rule matches traffic based on the referenced internal CA certificate’s signature algorithm type, in addition to any configured rule conditions. Because you associate one CA certificate with a Decrypt - Resign action, you cannot create an SSL rule that decrypts multiple types of outgoing traffic encrypted with different signature algorithms. In addition, any external certificate objects and cipher suites you add to the rule must match the associated CA certificate encryption algorithm type. 
 
    [bookmark: pgfId-3528601]For example, outgoing traffic encrypted with an elliptic curve (EC) algorithm matches a Decrypt - Resign rule only if the action references an EC-based CA certificate; you must add EC-based external certificates and cipher suites to the rule if you want to create certificate and cipher suite rule conditions. Similarly, a Decrypt - Resign rule that references an RSA-based CA certificate matches only outgoing traffic encrypted with an RSA algorithm; outgoing traffic encrypted with an EC algorithm does not match the rule, even if all other configured rule conditions match. 
 
    [bookmark: pgfId-3476557]Note the following:
 
     
     	 [bookmark: pgfId-3527572]You cannot use the  Decrypt - Known Key action in a passive deployment if the cipher suite used to establish the SSL connection applies either the Diffie-Hellman ephemeral (DHE) or the elliptic curve Diffie-Hellman ephemeral (ECDHE) key exchange algorithm. If your SSL policy targets a device with passive or inline (tap mode) interfaces, and contains a  Decrypt - Known Key rule with a cipher suite condition containing either a DHE or an ECDHE cipher suite, the system displays an information icon (
 
     [image: ] ) next to the rule. If you later add a zone condition to the SSL rule that contains passive or inline (tap mode) interfaces, the system displays a warning icon ( 
     [image: ] ). 
    
 
     
     	 [bookmark: pgfId-3506495]You cannot use the  Decrypt - Resign action in a passive or inline (tap mode) deployment, as the device does not directly inspect traffic. If you create a rule with the  Decrypt - Resign action that contains passive or inline (tap mode) interfaces within a security zone, the policy editor displays a warning icon (
 
     [image: ] ) next to the rule. If your SSL policy targets a device with passive or inline (tap mode) interfaces, and contains a 
      Decrypt - Resign rule, the system displays an information icon ( 
     [image: ] ) next to the rule. If you later add a zone condition to the SSL rule that contains passive or inline (tap mode) interfaces, the system displays a warning icon ( 
     [image: ] ). If you apply an SSL policy that contains a Decrypt - Resign rule to a device with passive or inline (tap mode) interfaces, any SSL sessions that match the rule fail. 
    
 
     
     	 [bookmark: pgfId-3506822]If the client does not trust the CA used to re-sign the server certificate, it warns the user that the certificate should not be trusted. To prevent this, import the CA certificate into the client trusted CA store. Alternatively, if your organization has a private PKI, you can issue an intermediate CA certificate signed by the root CA which is automatically trusted by all clients in the organization, then upload that CA certificate to the device.
 
     	 [bookmark: pgfId-3526077]The system cannot decrypt traffic encrypted with an anonymous cipher suite. You cannot use either the Decrypt - Resign or  Decrypt - Known Key action in an SSL rule if you add an anonymous cipher suite to the  Cipher Suite condition. 
 
     	 [bookmark: pgfId-3530879]The system cannot decrypt traffic if an HTTP proxy is positioned between a client and your managed device, and the client and server establish a tunneled SSL connection using the CONNECT HTTP method. The  Handshake Errors undecryptable action determines how the system handles this traffic. See Setting Default Handling for Undecryptable Traffic for more information.
 
     	 [bookmark: pgfId-3476560]You cannot match on  Distinguished Name or  Certificate conditions when creating an SSL rule with a  Decrypt - Known Key action. The assumption is that if this rule matches traffic, the certificate, subject DN, and issuer DN already match the certificate associated with the rule. For more information, see Using Rule Actions to Determine Encrypted Traffic Handling and Inspection.
 
     	 [bookmark: pgfId-3506562]If you create an internal CA object and choose to generate a certificate signing request (CSR), you cannot use this CA for a  Decrypt - Resign action until you upload the signed certificate to the object. For more information, see Obtaining and Uploading a New Signed Certificate.
 
     	 [bookmark: pgfId-3529254]If you configure a rule with the  Decrypt - Resign action, and mismatch signature algorithm type for one or more external certificate objects or cipher suites, the policy editor displays an information icon (
 
     [image: ] ) next to the rule. If you mismatch signature algorithm type for all external certificate objects, or all cipher suites, the policy displays a warning icon ( 
     [image: ] ) next to the rule, and you cannot apply the access control policy associated with the SSL policy. For more information, see 
     Controlling Encrypted Traffic by Certificate and 
     Controlling Encrypted Traffic by Cipher Suite. 
    
 
     
     	 [bookmark: pgfId-3505682]If decrypted traffic matches an access control rule with an action of  Interactive Block or  Interactive Block with reset , the system blocks the matching connection without interaction and the system does  not display a response page.
 
     	 [bookmark: pgfId-3505752]If you enable the  Normalize Excess Payload option in the inline normalization preprocessor, when the preprocessor normalizes decrypted traffic, it may drop a packet and replace it with a trimmed packet. This does not end the SSL session. If the traffic is allowed, the trimmed packet is encrypted as part of the SSL session. For more information on this option, see Normalizing Inline Traffic.
 
     	 [bookmark: pgfId-3546857]If your browser uses certificate pinning to verify a server certificate, you cannot decrypt this traffic by re-signing the server certificate. If you want to allow this traffic, configure an SSL rule with the Do not decrypt action to match the server certificate common name or distinguished name.
 
    
 
   
 
    
     [bookmark: pgfId-3405297][bookmark: 77107][bookmark: 27732]Managing SSL Rules in a Policy
 
    [bookmark: pgfId-3405377]License: Any
 
    [bookmark: pgfId-3433412]Supported Devices: Series 3
 
    [bookmark: pgfId-3497446]The Rules tab of the SSL policy editor, shown in the following graphic, allows you to add, edit, search, move, enable, disable, delete, and otherwise manage SSL rules within your policy. 
 
    [bookmark: pgfId-3549964]
 
     
     [image: ] 
    
 
     
      [bookmark: pgfId-3516780]
 
     [bookmark: pgfId-3516706]For each rule, the policy editor displays its name, a summary of its conditions, and the rule action. Icons represent warnings, errors, and other important information. Disabled rules are grayed out and marked (disabled) beneath the rule name. See Troubleshooting SSL Rules for more information about the icons. 
 
     [bookmark: pgfId-3487511]For information on managing SSL rules, see:
 
      
      	 [bookmark: pgfId-3486257]Searching SSL Rules
 
      	 [bookmark: pgfId-3486265]Enabling and Disabling SSL Rules
 
      	 [bookmark: pgfId-3486269]Changing an SSL Rule’s Position or Category
 
     
 
    
 
     
      [bookmark: pgfId-3475101][bookmark: 70646]Searc[bookmark: marker-3475100]hing SSL Rules
 
     [bookmark: pgfId-3511947]License: Any
 
     [bookmark: pgfId-3524048]Supported Devices: Series 3
 
     [bookmark: pgfId-3432307]You can search the list of SSL rules for matching values using an alphanumeric string, including spaces and printable, special characters. The search inspects the rule name and any rule condition you have added to the rule. For rule conditions, the search matches any name or value you can add for each condition type (zone, network, application, and so on). This includes individual object names or values, group object names, individual object names or values within a group, and literal values.
 
     [bookmark: pgfId-3432308]You can use complete or partial search strings. The column for matching values is highlighted for each matching rule. For example, if you search on all or part of the string 100Bao, at a minimum, the Applications column is highlighted for each rule where you have added the 100Bao application. If you also have a rule named 100Bao, both the Name and Applications columns are highlighted.
 
     [bookmark: pgfId-3432309]You can navigate to each previous or next matching rule. A status message displays the current match and the total number of matches.
 
     [bookmark: pgfId-3432310]Matches may occur on any page of a multi-page rule list. When the first match is not on the first page, the page where the first match occurs is displayed. Selecting the next match when you are at the last match takes you to the first match, and selecting the previous match when you are at the first match takes you to the last match.
 
     [bookmark: pgfId-3486503]To search for rules:
 
     [bookmark: pgfId-3486507]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3486508]Step 1 In the SSL policy editor for the policy you want to search, click the Search Rules prompt, type a search string, then press Enter. You can also use the Tab key or click a blank page area to initiate the search.
 
     [bookmark: pgfId-3486509]Columns for rules with matching values are highlighted, with differentiated highlighting for the indicated (first) match.
 
     [bookmark: pgfId-3486510]Step 2 Find the rules you are interested in:
 
      
       
       	 [bookmark: pgfId-3486517]To navigate between matching rules, click the next-match (
 
      
 
      [image: ] ) or previous-match ( 
      [image: ] ) icon. 
     
 
      
       
       	 [bookmark: pgfId-3486521]To refresh the page and clear the search string and any highlighting, click the clear icon (
 
      
 
      [image: ] ). 
     
 
     [bookmark: pgfId-3486522]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3441778][bookmark: 98504]Enabling and Disabling SSL Rules
 
     [bookmark: pgfId-3536537]License: Any
 
     [bookmark: pgfId-3536544]Supported Devices: Series 3
 
     [bookmark: pgfId-3486678]When you create an SSL rule, it is enabled by default. If you disable a rule, the system does not use it to evaluate network traffic and stops generating warnings and errors for that rule. When viewing the list of rules in an SSL policy, disabled rules are grayed out, although you can still modify them. Note that you can also enable or disable an SSL rule using the rule editor; see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3486682]To change an SSL rule’s state:
 
     [bookmark: pgfId-3486788]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3486789]Step 1 In the SSL policy editor for the policy that contains the rule you want to enable or disable, right-click the rule and choose a rule state:
 
      
       
       	 [bookmark: pgfId-3486688]To enable an inactive rule, select  State > Enable . 
 
       	 [bookmark: pgfId-3486689]To disable an active rule ,  State > Disable . 
 
      
 
     
 
     [bookmark: pgfId-3486690]Step 2 Click Save to save the policy.
 
     [bookmark: pgfId-3511158]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3486774]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3486777][bookmark: 87369]Changing an SSL Rule’s [bookmark: marker-3486776]Position or Category
 
     [bookmark: pgfId-3536583]License: Any
 
     [bookmark: pgfId-3536590]Supported Devices: Series 3
 
     [bookmark: pgfId-3536557]To help you organize SSL rules, every SSL policy has three system-provided rule categories: Administrator Rules, Standard Rules, and Root Rules. You cannot move, delete, or rename these categories, although you can create custom categories.
 
     [bookmark: pgfId-3486847]By default, any predefined user role that allows you to modify SSL policies also allows you to move and modify SSL rules within and among rules categories. You can, however, create custom roles that restrict users from moving and modifying rules.
 
     [bookmark: pgfId-3486848]For more information, see: 
 
      
      	 [bookmark: pgfId-3486852]Moving an SSL Rule
 
      	 [bookmark: pgfId-3486856]Adding a New SSL Rule Category
 
     
 
    
 
     
      [bookmark: pgfId-3442113][bookmark: 28954]Moving an SSL Rule
 
     [bookmark: pgfId-3536610]License: Any
 
     [bookmark: pgfId-3536617]Supported Devices: Series 3
 
     [bookmark: pgfId-3486940]Proper SSL rule order reduces the resources required to process network traffic, and prevents rule preemption. By default, any predefined user role that allows you to modify SSL policies also allows you to move SSL rules within and among rules categories. You can, however, create custom roles that restrict users from moving rules in the system-provided categories.
 
     [bookmark: pgfId-3486941]The following procedure explains how to move one or more rules at a time using the SSL policy editor. You can also move individual SSL rules using the rule editor; see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3486945]To move a rule:
 
     [bookmark: pgfId-3486949]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3486950]Step 1 In the SSL policy editor for the policy that contains the rules you want to move, select the rules by clicking in a blank area for each rule. Use the Ctrl and Shift keys to select multiple rules.
 
     [bookmark: pgfId-3486951]The rules you selected are highlighted.
 
     [bookmark: pgfId-3486952]Step 2 Move the rules. You can cut and paste or drag and drop.
 
     [bookmark: pgfId-3486953]To cut and paste rules into a new location, right-click a selected rule and select Cut. Then, right-click a blank area for a rule next to where you want to paste the cut rules and select Paste above or Paste below. Note that you cannot copy and paste SSL rules between two different SSL policies.
 
     [bookmark: pgfId-3486954]Step 3 Click Save to save the policy.
 
     [bookmark: pgfId-3511180]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3486959]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3487123][bookmark: 59239]Adding a New SSL Rule Category
 
     [bookmark: pgfId-3536637]License: Any
 
     [bookmark: pgfId-3536644]Supported Devices: Series 3
 
     [bookmark: pgfId-3487161]To help you organize SSL rules, every SSL policy has three system-provided rule categories: Administrator Rules, Standard Rules, and Root Rules. You cannot move, delete, or rename these categories, although you can create custom categories between the Standard Rules and Root Rules. 
 
     [bookmark: pgfId-3487162]Adding custom categories allows you to further organize your rules without having to create additional policies. You can rename and delete categories that you add. You cannot move these categories, but you can move rules into, within, and out of them.
 
     [bookmark: pgfId-3487163]You can create custom roles that restrict users from moving and modifying rules in the system-provided categories, based on the user permissions added to the role. For more information, see User Account Privileges.
 
     [bookmark: pgfId-3487164]To add a new category:
 
     [bookmark: pgfId-3487168]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3487169]Step 1 In the SSL policy editor for the policy where you want to add a rule category, click Add Category.
 
      
       
     
 
     
 
     [bookmark: pgfId-3487170]Tip If your policy already contains rules, you can click a blank area in the row for an existing rule to set the position of the new category before you add it. You can also right-click an existing rule and select Insert new category.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3487171]The Add Category pop-up window appears.
 
     [bookmark: pgfId-3487172]Step 2 Type a unique category Name.
 
     [bookmark: pgfId-3487173]You can enter an alphanumeric name, including spaces and special printable characters, with up to 30 characters.
 
     [bookmark: pgfId-3487174]Step 3 You have the following choices:
 
      
       
       	 [bookmark: pgfId-3487175]To position the new category immediately above an existing category, select  above Category from the first  Insert drop-down list, then select the category above which you want to position the rule from the second drop-down list.
 
       	 [bookmark: pgfId-3487176]To position the new category rule below an existing rule, select  below rule from the drop-down list, then enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
       	 [bookmark: pgfId-3487177]To position the rule above an existing rule, select  above rule from the drop-down list, then, enter an existing rule number. This option is valid only when at least one rule exists in the policy.
 
      
 
     
 
     [bookmark: pgfId-3487178]Step 4 Click OK.
 ) to delete the category. Rules in a category you delete are added to the category above. 
     
 
     [bookmark: pgfId-3487186]Step 5 Click Save to save the policy.
 
     [bookmark: pgfId-3487187]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3442290][bookmark: 33868]Troubleshooting SSL Rules
 
     [bookmark: pgfId-3512027]License: Any
 
     [bookmark: pgfId-3540554]Supported Devices: Series 3
 
     [bookmark: pgfId-3491096]Properly creating and ordering SSL rules is a complex task, but one that is essential to building an effective deployment. If you do not plan your policy carefully, rules can preempt other rules, require additional licenses, or contain invalid configurations. To help ensure that the system handles traffic as you expect, the SSL policy interface has a robust warning and error feedback system for rules. 
 
     [bookmark: pgfId-3491097]For each rule, icons in the policy editor mark warnings and errors, as described in the following table. Hover your pointer over the icon to read the warning, error, or informational text.
 
     [bookmark: pgfId-3491149]
 
      
      
 
      
 
      
 
       
        
        [bookmark: pgfId-3491103]Table 21-2 SSL Error Icons 
 
        
        
         
         	 
           
           [bookmark: pgfId-3491109]Icon 
          
  
         	 
           
           [bookmark: pgfId-3491111]Description 
          
  
         	 
           
           [bookmark: pgfId-3491113]Details 
          
  
        
 
        
           
         	[bookmark: pgfId-3491120]warning
  
         	[bookmark: pgfId-3491122]Depending on the issue, you may be able to apply an SSL policy that displays rule or other warnings. In these cases, the misconfigured settings will have no effect. For example, a preempted rule never evaluates traffic. However, if a warning icon marks a licensing error or model mismatch, you cannot apply the policy until you correct the issue.
 [bookmark: pgfId-3491123]If you disable a rule with a warning, the warning icon disappears. It reappears if you enable the rule without correcting the underlying issue.
  
        
 
        
           
         	[bookmark: pgfId-3491130]error
  
         	[bookmark: pgfId-3491132]If a rule or other SSL policy configuration has an error, you cannot apply the policy until you correct the issue.
  
        
 
        
           
         	[bookmark: pgfId-3491139]information
  
         	[bookmark: pgfId-3491141]Information icons convey helpful information about configurations that may affect the flow of traffic. These issues are minor and will not prevent you from applying the policy.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3491150]Properly configuring SSL rules can also reduce the resources required to process network traffic. Creating complex rules and mis-ordering rules can affect performance.
 
     [bookmark: pgfId-3491151]For more information, see:
 
      
      	 [bookmark: pgfId-3491155]Understanding SSL Rule Warnings and Errors
 
      	 [bookmark: pgfId-3515709]Understanding Rule Preemption and Invalid Configuration Warnings
 
      	 [bookmark: pgfId-3515714]Ordering SSL Rules to Improve Performance and Avoid Preemption
 
     
 
    
 
     
      [bookmark: pgfId-3442349][bookmark: 80400]Understanding SSL Rule Warnings and Errors
 
     [bookmark: pgfId-3540586]License: feature dependent
 
     [bookmark: pgfId-3491743]Supported Devices: Series 3
 
     [bookmark: pgfId-3536519]Although you can create SSL rules with any license, certain rule conditions and inspection options require that you enable specific licensed capabilities on the targeted device. You cannot apply a policy that uses licensed capabilities to unlicensed devices. The system uses warning icons and confirmation dialogs to designate unlicensed features. For details, hover your pointer over a warning icon.
 
     [bookmark: pgfId-3491368]The following table explains the licenses you must have to use SSL rules.
 
     [bookmark: pgfId-3497421]
 
      
       
        
        [bookmark: pgfId-3536715]Table 21-3 License Requirements for SSL Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-3536721]To use rules... 
          
  
         	 
           
           [bookmark: pgfId-3536723]License 
          
  
         	 
           
           [bookmark: pgfId-3542004]Supported Defense Centers 
          
  
         	 
           
           [bookmark: pgfId-3536725]Supported Devices 
          
  
        
 
         
         	[bookmark: pgfId-3536727]with zone, network, VLAN, port, certificate, DN, certificate status, cipher suite, or version conditions
  
         	[bookmark: pgfId-3536732]Any
  
         	[bookmark: pgfId-3542006]Any
  
         	[bookmark: pgfId-3536737]Series 3
  
        
 
         
         	[bookmark: pgfId-3541871]with network conditions that use geolocation data
  
         	[bookmark: pgfId-3541873]FireSIGHT
  
         	[bookmark: pgfId-3542008]Any except DC500
  
         	[bookmark: pgfId-3541875]Series 3
  
        
 
         
         	[bookmark: pgfId-3536739]with application or user conditions
  
         	[bookmark: pgfId-3536744]Control
  
         	[bookmark: pgfId-3542013]Any, except the DC500 cannot perform user control
  
         	[bookmark: pgfId-3536749]Series 3
  
        
 
         
         	[bookmark: pgfId-3536751]with category conditions that use URL category and reputation data
  
         	[bookmark: pgfId-3536756]URL Filtering
  
         	[bookmark: pgfId-3542018]Any except DC500
  
         	[bookmark: pgfId-3536761]Series 3
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3497435][bookmark: 19894]Understanding Rule Preemption and Invalid Configuration Warnings
 
     [bookmark: pgfId-3540605]License: Any
 
     [bookmark: pgfId-3512049]Supported Devices: Series 3
 
     [bookmark: pgfId-3491914]Properly configuring and ordering SSL rules is essential to building an effective deployment. Within an SSL policy, SSL rules can preempt other rules or contain invalid configurations. The system uses warning and error icons to mark these issues.
 
     [bookmark: pgfId-3491915]Understanding Rule Preemption Warnings
 
     [bookmark: pgfId-3491916]The conditions of an SSL rule may preempt a subsequent rule from matching traffic. For example:
 
      
      [bookmark: pgfId-3491917]Rule 1: do not decrypt Administrators 
     
 
      
      [bookmark: pgfId-3491918]Rule 2: block Administrators 
     
 
     [bookmark: pgfId-3491919]The second rule above will never block traffic because the first rule will have already allowed the traffic.
 
     [bookmark: pgfId-3491920]Any type of rule condition can preempt a subsequent rule. For example, the VLAN range in the first rule below includes the VLAN in the second rule, so the first rule preempts the second rule:
 
      
      [bookmark: pgfId-3491921]Rule 1: do not decrypt VLAN 22-33 
     
 
      
      [bookmark: pgfId-3491922]Rule 2: block VLAN 27 
     
 
     [bookmark: pgfId-3491923]In the following example, Rule 1 matches any VLAN because no VLANs are configured, so Rule 1 preempts Rule 2, which attempts to match VLAN 2:
 
      
      [bookmark: pgfId-3491924]Rule 1: do not decrypt Source Network 10.4.0.2/16 
     
 
      
      [bookmark: pgfId-3491925]Rule 2: do not decrypt Source Network 10.4.0.2/16, VLAN 2 
     
 
     [bookmark: pgfId-3491926]A rule also preempts an identical subsequent rule where all configured conditions are the same. For example:
 
      
      [bookmark: pgfId-3491927]Rule 1: do not decrypt VLAN 1 URL www.example.com 
     
 
      
      [bookmark: pgfId-3491928]Rule 2: do not decrypt VLAN 1 URL www.example.com 
     
 
     [bookmark: pgfId-3491929]A subsequent rule would not be preempted if any condition is different. For example:
 
      
      [bookmark: pgfId-3491930]Rule 1: do not decrypt VLAN 1 URL www.example.com 
     
 
      
      [bookmark: pgfId-3491931]Rule 2: do not decrypt VLAN 2 URL www.example.com 
     
 
     [bookmark: pgfId-3491932]Understanding Invalid Configuration Warnings
 
     [bookmark: pgfId-3491933]Because outside settings that the SSL policy depends on may change, an SSL policy setting that was valid may become invalid. Consider the following examples:
 
      
      	 [bookmark: pgfId-3526801]A rule that contains a URL category condition might be valid until you target a device that does not have a URL Filtering license. At that point, an error icon appears next to the rule, and you cannot apply the policy to that device until you edit or delete the rule, retarget the policy, or enable the appropriate license. 
 
      	 [bookmark: pgfId-3526805]If you create a Decrypt-Resign rule, and later add a security zone with passive interfaces to a zone condition, the system displays a warning icon next to the rule. Because you cannot decrypt traffic by re-signing a certificate in a passive deployment, the rule has no effect until you remove the passive interfaces from the rule or change the rule action.
 
      	 [bookmark: pgfId-3491939]If you add a user to a rule, then change your LDAP user awareness settings to exclude that user, the rule will have no effect because the user is no longer an access-controlled user. 
 
     
 
    
 
     
      [bookmark: pgfId-3442398][bookmark: 60943]Ordering SSL Rules to Improve Performance and Avoid Preemption
 
     [bookmark: pgfId-3540624]License: Any
 
     [bookmark: pgfId-3512067]Supported Devices: Series 3
 
     [bookmark: pgfId-3492884]Rules in an SSL policy are numbered, starting at 1. The system matches traffic to rules in top-down order by ascending rule number. With the exception of Monitor rules, the first rule that traffic matches is the rule that handles that traffic.
 
     [bookmark: pgfId-3492885]Proper SSL rule order reduces the resources required to process network traffic, and prevents rule preemption. Although the rules you create are unique to every organization and deployment, there are a few general guidelines to follow when ordering rules that can optimize performance while still addressing your needs.
 
     [bookmark: pgfId-3492886]Order Rules from Most to Least Critical
 
     [bookmark: pgfId-3492887]First, you must order rules to suit your organization's needs. Place priority rules that must apply to all traffic near the top of the policy. For example, if you want to decrypt outgoing traffic from a single user for further analysis (using a Decrypt-Resign rule), but not decrypt traffic from all other users in the department (using a Do not decrypt rule), place two SSL rules in that order.
 
     [bookmark: pgfId-3492888]Order Rules from Specific to General
 
     [bookmark: pgfId-3492889]You can improve performance by placing specific rules earlier, that is, rules that narrowly define the traffic they handle. This is also important because rules with broad conditions can match many different types of traffic, and can preempt later, more specific rules.
 
     [bookmark: pgfId-3492890]Consider a scenario where a trusted CA (Good CA) mistakenly issued a CA certificate to a malicious entity (Bad CA), but has not yet revoked that certificate. You want to block traffic encrypted with certificates issued by the untrusted CA, but otherwise allow traffic within the trusted CA’s chain of trust. You should upload the CA certificates and all intermediate CA certificates, then order your rules as follows:
 
      
      [bookmark: pgfId-3496095]Rule 1: Block issuer CN=www.badca.com 
     
 
      
      [bookmark: pgfId-3496096]Rule 2: Do not decrypt issuer CN=www.goodca.com 
     
 
     [bookmark: pgfId-3496291]If you reverse the rules:
 
      
      [bookmark: pgfId-3496318]Rule 1: Do not decrypt issuer CN=www.goodca.com 
     
 
      
      [bookmark: pgfId-3496326]Rule 2: Block issuer CN=www.badca.com 
     
 
     [bookmark: pgfId-3496320]the first rule matches all traffic trusted by Good CA, including traffic trusted by Bad CA. Because no traffic ever matches the second rule, malicious traffic may be allowed instead of blocked.
 
     [bookmark: pgfId-3546810]Order Rules to Allow Traffic from Certificate Pinned Sites
 
     [bookmark: pgfId-3546821]Certificate pinning forces a client's browser to verify that a server's public key certificate matches a certificate the browser already associated with the server before establishing an SSL session. Because the Decrypt - Resign action involves modifying a server certificate before passing it to the client, these modified certificates are rejected if the browser already pinned that certificate. 
 
     [bookmark: pgfId-3546823]For example, if a client browser connects to windowsupdate.microsoft.com, a site that uses certificate pinning, and you configure an SSL rule that matches that traffic with a Decrypt - Resign action, the system re-signs the server certificate before passing it to the client browser. Because this modified server certificate does not match the browser's pinned certificate for windowsupdate.microsoft.com, the client browser rejects the connection. 
 
     [bookmark: pgfId-3546849]If you want to allow this traffic, configure an SSL rule with the Do not decrypt action to match the server certificate common name or distinguished name. In the SSL policy, order this rule before all Decrypt - Resign rules that also match the traffic. You can retrieve the pinned certificate from the client's browser after a successful connection to the website. You can also view the certificate from the logged connection event, whether the connection succeeded or failed. 
 
     [bookmark: pgfId-3546850]Place Rules that Decrypt Traffic Later
 
     [bookmark: pgfId-3546812]Because traffic decryption requires processing resources, placing rules that do not decrypt traffic (Do not decrypt, Block) before rules that do (Decrypt-Known Key, Decrypt-Resign) can improve performance. This is because traffic decryption can command significant resources. In addition, Block rules can divert traffic that the system might otherwise have decrypted or inspected. All other factors being equal, that is, given a set of rules where none is more critical and preemption is not an issue, consider placing them in the following order:
 
      
      	 [bookmark: pgfId-3492899]Monitor rules that log matching connections, but take no other action on traffic
 
      	 [bookmark: pgfId-3537888]Block rules that block traffic without further inspection
 
      	 [bookmark: pgfId-3537952]Do not decrypt rules that do not decrypt encrypted traffic
 
      	 [bookmark: pgfId-3493148]Decrypt-Known Key rules that decrypt incoming traffic with a known private key
 
      	 [bookmark: pgfId-3493243]Decrypt-Resign rules that decrypt outgoing traffic by re-signing the server certificate
 
     
 
    
 
     
      [bookmark: pgfId-3492945]Configuring SSL Inspection to Improve Performance
 
     [bookmark: pgfId-3540643]License: Any
 
     [bookmark: pgfId-3512088]Supported Devices: Series 3
 
     [bookmark: pgfId-3493742]Complex SSL policies and rules can command significant resources. When you apply an SSL policy, the system evaluates all the rules together and creates an expanded set of criteria that target devices use to evaluate network traffic. A pop-up window may warn that you have exceeded the maximum number of SSL rules supported by a target device. This maximum depends on a number of factors, including the physical memory and the number of processors on the device. 
 
     [bookmark: pgfId-3493743]Simplifying Rules
 
     [bookmark: pgfId-3493744]The following guidelines can help you simplify your SSL rules and improve performance:
 
      
      	 [bookmark: pgfId-3492926]When constructing a rule, use as few individual elements in your conditions as possible. For example, in network conditions, use IP address blocks rather than individual IP addresses. In port conditions, use port ranges. Use application filters and URL categories and reputations to perform application control and URL filtering, and LDAP user groups to perform user control.
 
     
 
     [bookmark: pgfId-3492927]Note that combining elements into objects that you then use in SSL rule conditions does not improve performance. For example, using a network object that contains 50 individual IP addresses gives you only an organizational—not a performance—benefit over including those IP addresses in the condition individually.
 
      
      	 [bookmark: pgfId-3492928]Restrict rules by security zones whenever possible. If a device’s interfaces are not in one of the zones in a zone-restricted rule, the rule does not affect performance on that device.
 
      	 [bookmark: pgfId-3492929]Do not overconfigure rules. If one condition is enough to match the traffic you want to handle, do not use two.
 
     
 
     [bookmark: pgfId-3493749]Configuring Traffic Decryption
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3405103][bookmark: 41231]Tuning Traffic Decryption Using SSL Rules 
      
      
 
     
 
 
    [bookmark: pgfId-3451684]A basic SSL rule applies its rule action to all encrypted traffic inspected by the device. To better control and decrypt encrypted traffic, you can configure rule conditions to handle and log specific types of traffic. Each SSL rule can contain 0, 1, or more rule conditions; a rule only matches traffic if the traffic matches every condition in that SSL rule.
 
     
      
    
 
    
 
    [bookmark: pgfId-3507868]Note When traffic matches a rule, the device applies the configure rule action to the traffic. When the connection ends, the device logs the traffic if configured to do so. For more information, see Using Rule Actions to Determine Encrypted Traffic Handling and Inspection and Logging Encrypted Connections.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3507588]Each rule condition allows you to specify one or more properties of traffic you want to match against; these properties include details of: 
 
     
     	 [bookmark: pgfId-3501774]the flow of traffic, including the security zone through which it travels, IP address and port, country of origin or destination, and origin or destination VLAN
 
     	 [bookmark: pgfId-3547773]the user associated with a detected IP address
 
     	 [bookmark: pgfId-3508315]the traffic payload, including the application detected in the traffic
 
     	 [bookmark: pgfId-3508524]the connection encryption, including the SSL/TLS protocol version and cipher suite and server certificate used to encrypt the connection
 
     	 [bookmark: pgfId-3547927]the category and reputation of the URL specified in the server certificate’s distinguished name
 
    
 
    [bookmark: pgfId-3407211]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3407217]Logging Decryptable Connections with SSL Rules
 
     	 [bookmark: pgfId-3411462]Controlling Encrypted Traffic with Network-Based Conditions
 
     	 [bookmark: pgfId-3407238]Controlling Encrypted Traffic by Reputation
 
     	 [bookmark: pgfId-3524411]Controlling Traffic Based on Encryption Properties
 
    
 
   
 
    
     [bookmark: pgfId-3551799][bookmark: 91788]Controlling Encrypted Traffic with [bookmark: marker-3551798]Network-Based Conditions
 
    [bookmark: pgfId-3551806]License: Any
 
    [bookmark: pgfId-3551813]Supported Devices: Series 3
 
    [bookmark: pgfId-3529976]SSL rules within SSL policies exert granular control over encrypted traffic logging and handling. Network-based conditions allow you to manage which encrypted traffic can traverse your network, using one or more of the following criteria:
 
     
     	 [bookmark: pgfId-3529977]source and destination security zones
 
     	 [bookmark: pgfId-3529978]source and destination IP addresses or geographical locations
 
     	 [bookmark: pgfId-3529979]a packet’s innermost VLAN tag
 
     	 [bookmark: pgfId-3529980]source and destination port
 
    
 
    [bookmark: pgfId-3529981]You can combine network-based conditions with each other and with other types of conditions to create an SSL rule. These SSL rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on SSL rules, see Getting Started with SSL Rules.
 
    [bookmark: pgfId-3530720]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3410211]Controlling Encrypted Traffic by Network Zone
 
     	 [bookmark: pgfId-3410225]Controlling Encrypted Traffic by Network or Geographical Location
 
     	 [bookmark: pgfId-3410228]Controlling Encrypted VLAN Traffic
 
     	 [bookmark: pgfId-3410245]Controlling Encrypted Traffic by Port
 
    
 
     
      [bookmark: pgfId-3405548][bookmark: 37378]Controlling Encrypted Traffic by Network Zone
 
     [bookmark: pgfId-3405756]License: Any
 
     [bookmark: pgfId-3450798]Supported Devices: Series 3
 
     [bookmark: pgfId-3464082]Zone conditions in SSL rules allow you to control encrypted traffic by its source and destination security zones.
 
     [bookmark: pgfId-3464083]A security zone is a grouping of one or more interfaces, which may be located across multiple devices. An option you choose during a device’s initial setup, called its detection mode, determines how the system initially configures the device’s interfaces, and whether those interfaces belong to a security zone.
 
     [bookmark: pgfId-3464087]As a simple example, when you register a device with an Inline detection mode, the Defense Center creates two zones: Internal and External, and assigns the first pair of interfaces on the device to those zones. Hosts connected to the network on the Internal side represent your protected assets.
 
     [bookmark: pgfId-3468012]To extend this scenario, you could deploy additional identically configured devices—managed by the same Defense Center—to protect similar resources in several different locations. Like the first device, each of these devices protects the assets in its Internal security zone.
 
      
       
     
 
     
 
     [bookmark: pgfId-3468016]Tip You are not required to group all internal (or external) interfaces into a single zone. Choose the grouping that makes sense for your deployment and security policies. For more information on creating zones, see Working with Security Zones.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3526402]In this deployment, you may decide that although you want these hosts to have unrestricted access to the Internet, you nevertheless want to protect them by decrypting and inspecting incoming encrypted traffic.
 
     [bookmark: pgfId-3526403]To accomplish this with SSL inspection, configure an SSL rule with a zone condition where the Destination Zone is set to Internal. This simple SSL rule matches traffic that leaves the device from any interface in the Internal zone.
 
     [bookmark: pgfId-3526413]If you want to build a more complex rule, you can add a maximum of 50 zones to each of the Sources Zones and Destination Zones in a single zone condition:
 
      
      	 [bookmark: pgfId-3464116]To match encrypted traffic  leaving the device from an interface in the zone, add that zone to the  Destination Zones .
 
     
 
     [bookmark: pgfId-3464117]Because devices deployed passively do not transmit traffic, you cannot use a zone comprised of passive interfaces in a Destination Zone condition.
 
      
      	 [bookmark: pgfId-3464122]To match encrypted traffic  entering the device from an interface in the zone, add that zone to the  Source Zones .
 
     
 
     [bookmark: pgfId-3464123]If you add both source and destination zone conditions to a rule, matching traffic must originate from one of the specified source zones and egress through one of the destination zones. 
 
     [bookmark: pgfId-3464124]Note that just as all interfaces in a zone must be of the same type (all inline, all passive, all switched, or all routed), all zones used in a zone condition for an SSL rule must be of the same type. That is, you cannot write a single rule that matches encrypted traffic to or from zones of different types.
 
     [bookmark: pgfId-3464128]Warning icons indicate invalid configurations, such as zones that contain no interfaces. For details, hover your pointer over the icon.
 
     [bookmark: pgfId-3464129]To control encrypted traffic by zone:
 
     [bookmark: pgfId-3464133]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3464134]Step 1 In the SSL policy where you want to control encrypted traffic by zone, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3464138]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3464139]Step 2 In the SSL rule editor, select the Zones tab.
 
     [bookmark: pgfId-3464140]The Zones tab appears.
 
     [bookmark: pgfId-3464141]Step 3 Find and select the zones you want to add from the Available Zones. 
 
     [bookmark: pgfId-3464142]To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones. 
 
     [bookmark: pgfId-3464143]Click to select a zone. To select multiple zones, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3464144]Step 4 Click Add to Source or Add to Destination to add the selected zones to the appropriate list. 
 
     [bookmark: pgfId-3464145]You can also drag and drop selected zones.
 
     [bookmark: pgfId-3464146]Step 5 Save or continue editing the rule.
 
     [bookmark: pgfId-3464149]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy. 
 
     [bookmark: pgfId-3464151]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3405607][bookmark: 34365]Controlling Encrypted Traffic by Network or Geographical Location
 
     [bookmark: pgfId-3405766]License: Any
 
     [bookmark: pgfId-3450847]Supported Devices: Series 3
 
     [bookmark: pgfId-3464300]Network conditions in SSL rules allow you to control and decrypt encrypted traffic by its source and destination IP address. You can either:
 
      
      	 [bookmark: pgfId-3464301]explicitly specify the source and destination IP addresses for the encrypted traffic you want to control, or
 
      	 [bookmark: pgfId-3464302]use the geolocation feature, which associates IP addresses with geographical locations, to control encrypted traffic based on its source or destination country or continent
 
     
 
     [bookmark: pgfId-3464303]When you build a network-based SSL rule condition, you can manually specify IP address and geographical locations. Alternately, you can configure network conditions with network and geolocation objects, which are reusable and associate a name with one or more IP addresses, address blocks, countries, continents, and so on. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3464304]Tip After you create a network or geolocation object, you can use it not only to build SSL rules, but also to represent IP addresses in various other places in the system’s web interface. You can create these objects using the object manager; you can also create network objects on-the-fly while you are configuring SSL rules. For more information, see Managing Reusable Objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3464308]Note that if you want to write rules to control traffic by geographical location, to ensure you are using up-to-date geolocation data to filter your traffic, Cisco strongly recommends you regularly update the geolocation database (GeoDB) on your Defense Center; see Updating the Geolocation Database. 
 
     [bookmark: pgfId-3464375]The following graphic shows the network condition for an SSL rule that blocks encrypted connections originating from your internal network and attempting to access resources either in the Cayman Islands or an offshore holding corporation server at 182.16.0.3.
 
     [bookmark: pgfId-3568579]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3491877]The example manually specifies the offshore holding corporation’s server IP address, and uses a system-provided Cayman Islands geolocation object to represent Cayman Island IP addresses.
 
     [bookmark: pgfId-3464388]You can add a maximum of 50 items to each of the Source Networks and Destination Networks in a single network condition, and you can mix network and geolocation-based configurations:
 
      
      	 [bookmark: pgfId-3464389]To match encrypted traffic  from an IP address or geographical location, configure the  Source Networks .
 
      	 [bookmark: pgfId-3464390]To match encrypted traffic  to an IP address or geographical location, configure the  Destination Networks .
 
     
 
     [bookmark: pgfId-3464395]If you add both source and destination network conditions to a rule, matching encrypted traffic must originate from one of the specified IP addresses and be destined for one of the destination IP addresses. 
 
     [bookmark: pgfId-3464399]When building a network condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon.
 
     [bookmark: pgfId-3464400]To control traffic by network or geographical location:
 
     [bookmark: pgfId-3464404]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3464405]Step 1 In the SSL policy where you want to control encrypted traffic by network, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3464409]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3464410]Step 2 In the SSL rule editor, select the Networks tab.
 
     [bookmark: pgfId-3464411]The Networks tab appears.
 
     [bookmark: pgfId-3464412]Step 3 Find and select the networks you want to add from the Available Networks, as follows:
 
      
       
       	 [bookmark: pgfId-3464413]Click the Networks tab to display network objects and groups to add; click the Geolocation tab to display geolocation objects. 
 
       	 [bookmark: pgfId-3464417]To add a network object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the Available Networks list; see 
      Working with Network Objects. 
     
 
      
       
       	 [bookmark: pgfId-3464421]To search for network or geolocation objects to add, select the appropriate tab, click the  Search by name or value  prompt above the  Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3464422]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3464423]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
     [bookmark: pgfId-3464424]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3464425]Step 5 Add any source or destination IP addresses or address blocks that you want to specify manually.
 
     [bookmark: pgfId-3464426]Click the Enter an IP address prompt below the Source Networks or Destination Networks list; then type an IP address or address block and click Add.
 
     [bookmark: pgfId-3464427]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-3464430]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3406776]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3405662][bookmark: 48411]Controlling Encrypted VLAN Traffic
 
     [bookmark: pgfId-3451016]License: Any
 
     [bookmark: pgfId-3451094]Supported Devices: Series 3
 
     [bookmark: pgfId-3464599]VLAN conditions in SSL rules allow you to control VLAN-tagged traffic. The system uses the innermost VLAN tag to identify a packet by VLAN.
 
     [bookmark: pgfId-3464600]When you build a VLAN-based SSL rule condition, you can manually specify a VLAN tag from 1 to 4094. Alternately, you can configure VLAN conditions with VLAN tag objects, which are reusable and associate a name with one or more VLAN tags. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3464601]Tip After you create a VLAN tag object, you can use it not only to build SSL rules, but also to represent VLAN tags in various other places in the system’s web interface. You can create VLAN tag objects either using the object manager or on-the-fly while you are configuring access control rules. For more information, see Working with VLAN Tag Objects.
 
      
      
 
     
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3549943]You can add a maximum of 50 items to the Selected VLAN Tags in a single VLAN tag condition. When building a VLAN tag condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon.
 
     [bookmark: pgfId-3464618]To control traffic by VLAN tag:
 
     [bookmark: pgfId-3464622]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3464623]Step 1 In the SSL policy where you want to control traffic by VLAN tag, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3464627]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3464628]Step 2 In the SSL rule editor, select the VLAN Tags tab.
 
     [bookmark: pgfId-3491013]The VLAN Tags tab appears.
 
     [bookmark: pgfId-3491014]Step 3 Find and select the VLANs you want to add from the Available VLAN Tags, as follows:
 
      
       
       	 [bookmark: pgfId-3491015]To add a VLAN tag object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the Available VLAN Tags list; see 
      Working with VLAN Tag Objects. 
     
 
      
       
       	 [bookmark: pgfId-3464638]To search for VLAN tag objects and groups to add, click the  Search by name or value  prompt above the  Available VLAN Tags  list, then type either the name of the object, or the value of a VLAN tag in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3464639]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3464640]Step 4 Click Add to Rule or to add the selected objects to the Selected VLAN Tags list. 
 
     [bookmark: pgfId-3464641]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3464642]Step 5 Add any VLAN tags that you want to specify manually.
 
     [bookmark: pgfId-3464643]Click the Enter a VLAN Tag prompt below the Selected VLAN Tags list; then type a VLAN tag or range and click Add. You can specify any VLAN tag from 1 to 4094; use a hyphen to specify a range of VLAN tags.
 
     [bookmark: pgfId-3464644]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-3509460]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3464649]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3405696][bookmark: 25656]Controlling Encrypted Traffic by Port
 
     [bookmark: pgfId-3405788]License: Any
 
     [bookmark: pgfId-3451215]Supported Devices: Series 3
 
     [bookmark: pgfId-3463735]Port conditions in SSL rules allow you to control encrypted traffic by its source and destination TCP port. When you build a port-based SSL rule condition, you can manually specify TCP ports. Alternately, you can configure port conditions with port objects, which are reusable and associate a name with one or more ports. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3463740]Tip After you create a port object, you can use it not only to build SSL rules, but also to represent ports in various other places in the system’s web interface. You can create port objects either using the object manager or on-the-fly while you are configuring SSL rules. For more information, see Working with Port Objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3469528]You can add a maximum of 50 items to each of the Selected Source Ports and Selected Destination Ports lists in a single network condition:
 
      
      	 [bookmark: pgfId-3463745]To match encrypted traffic  from a TCP port, configure the  Selected Source Ports .
 
      	 [bookmark: pgfId-3463747]To match encrypted traffic  to a TCP port, configure the  Selected Destination Ports .
 
      	 [bookmark: pgfId-3463749]To match encrypted traffic both originating from TCP  Selected Source Ports  and destined for TCP  Selected Destination Ports , configure both.
 
     
 
     [bookmark: pgfId-3549932]You can only configure the Selected Source Ports and Selected Destination Ports lists with TCP ports. Port objects containing non-TCP ports are greyed out in the Available Ports list.
 
     [bookmark: pgfId-3549936]When building a port condition, warning icons indicate invalid configurations. For example, you can use the object manager to edit in-use port objects so that the rules that use those object groups become invalid. For details, hover your pointer over the icon. 
 
     [bookmark: pgfId-3463759]To control traffic by port:
 
     [bookmark: pgfId-3463763]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3463764]Step 1 In the SSL policy where you want to control encrypted traffic by TCP port, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3463768]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3463769]Step 2 In the SSL rule editor, select the Ports tab.
 
     [bookmark: pgfId-3463770]The Ports tab appears.
 
     [bookmark: pgfId-3463771]Step 3 Find and select the TCP ports you want to add from the Available Ports, as follows:
 
      
       
       	 [bookmark: pgfId-3463775]To add a TCP port object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the Available Ports list; see 
      Working with Port Objects. 
     
 
      
       
       	 [bookmark: pgfId-3463779]To search for TCP-based port objects and groups to add, click the  Search by name or value  prompt above the  Available Ports  list, then type either the name of the object, or the value of a port in the object. The list updates as you type to display matching objects. For example, if you type 443, the Defense Center displays the system-provided HTTPS port object. 
 
      
 
     
 
     [bookmark: pgfId-3463786]To select a TCP-based port object, click it. To select multiple TCP-based port objects, use the Shift and Ctrl keys, or right-click and then select Select All. If the object includes non-TCP-based ports, you cannot add it to your port condition.
 
     [bookmark: pgfId-3463787]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
     [bookmark: pgfId-3463788]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3463789]Step 5 Enter a Port under the Selected Source Ports or Selected Destination Ports list to manually specify source or destination ports. You can specify a single port with a value from 0 to 65535.
 
     [bookmark: pgfId-3465773]Step 6 Click Add. 
 
     [bookmark: pgfId-3527422]Note that the Defense Center will not add a port to a rule condition that results in an invalid configuration.
 
     [bookmark: pgfId-3463800]Step 7 Save or continue editing the rule.
 
     [bookmark: pgfId-3509479]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3532586]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3532625][bookmark: 29657]Controlling Encrypted Traffic Based on User
 
    [bookmark: pgfId-3532632]License: Control
 
    [bookmark: pgfId-3532639]Supported Devices: Series 3
 
    [bookmark: pgfId-3534913]You can configure SSL rules to match traffic for users retrieved from a Microsoft Active Directory Server. User conditions in SSL rules allow you perform user control—to manage which traffic can traverse your network, by limiting traffic based on the LDAP user logged into a host. 
 
    [bookmark: pgfId-3534914]User control works by associating access controlled users with IP addresses. Deployed agents monitor specified users as they log in and out of hosts or authenticate with Active Directory credentials for other reasons. For example, your organization may use services or applications that rely on Active Directory for centralized authentication.
 
    [bookmark: pgfId-3534915]For traffic to match an SSL rule with a user condition, the IP address of either the source or destination host in the monitored session must be associated with a logged in access controlled user. You can control traffic based on individual users or the groups those users belong to.
 
    [bookmark: pgfId-3532648]You can combine user conditions with each other and with other types of conditions to create an SSL rule. These SSL rules can be simple or complex, matching and inspecting traffic using multiple conditions. For detailed information on SSL rules, see Understanding and Creating SSL Rules.
 
    [bookmark: pgfId-3535025]User control requires a Control license and is supported only for LDAP users and groups (access controlled users), using login and logoff records reported by a User Agent monitoring Microsoft Active Directory servers. 
 
    [bookmark: pgfId-3535288]Before you can write SSL rules with user conditions, you must configure a connection between the Defense Center and at least one of your organization’s Microsoft Active Directory servers. This configuration, called an authentication object, contains connection settings and authentication filter settings for the server. It also specifies the users you can use in user conditions. For more information, see Retrieving Access-Controlled Users and LDAP User Metadata.
 
    [bookmark: pgfId-3535295]In addition, you must install User Agents. The agents monitor users when they authenticate against Active Directory credentials, and send records of those logins to the Defense Center. These records associate users with IP addresses, which is what allows SSL rules with user conditions to trigger. For more information, see Using User Agents to Report Active Directory Logins.
 
    [bookmark: pgfId-3532663]To control encrypted traffic by user:
 
    [bookmark: pgfId-3532667]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-3532668]Step 1 In the SSL policy where you want to control encrypted traffic by user, create a new SSL rule or edit an existing rule.
 
    [bookmark: pgfId-3532672]For detailed instructions, see Understanding and Creating SSL Rules.
 
    [bookmark: pgfId-3532673]Step 2 In the SSL rule editor, select the Users tab.
 
    [bookmark: pgfId-3532674]The Users tab appears.
 
    [bookmark: pgfId-3532675]Step 3 To search for users to add, click the Search by name or value prompt above the Available Users list, then type the username. The list updates as you type to display matching users.
 
    [bookmark: pgfId-3532676]To select a user, click it. To select multiple users, use the Shift and Ctrl keys, or right-click and then select Select All.
 
    [bookmark: pgfId-3532677]Step 4 Click Add to Rule or to add the selected users to the Selected Users list. 
 
    [bookmark: pgfId-3532678]You can also drag and drop selected users.
 
    [bookmark: pgfId-3532679]Step 5 Save or continue editing the rule.
 
    [bookmark: pgfId-3532680]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-3532684]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3532589][bookmark: 48838]Controlling Encrypted Traffic by Reputation[bookmark: marker-3532588]
 
    [bookmark: pgfId-3532599]License: Control or URL Filtering
 
    [bookmark: pgfId-3451248]Supported Devices: Series 3
 
    [bookmark: pgfId-3530776]Reputation-based conditions in SSL rules allow you to manage which encrypted traffic can traverse your network, by contextualizing your network traffic and limiting it where appropriate. SSL rules govern the following types of reputation-based control:
 
     
     	 [bookmark: pgfId-3530777]Application conditions allow you to perform  application control , which controls application traffic based on not only individual applications, but also applications’ basic characteristics: type, risk, business relevance, and categories.
 
     	 [bookmark: pgfId-3530778]URL conditions allow you to control web traffic based on a websites’ assigned category and reputation.
 
    
 
    [bookmark: pgfId-3530779]You can combine reputation-based conditions with each other and with other types of conditions to create an SSL rule. These SSL rules can be simple or complex, matching and inspecting traffic using multiple conditions. 
 
     
      
       
       [bookmark: pgfId-3533109]Table 22-1 License and Appliance Requirements for Reputation-Based SSL Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-3533116]Requirement 
         
  
        	 
          
          [bookmark: pgfId-3533118]Application Control 
         
  
        	 
          
          [bookmark: pgfId-3533120]URL Filtering (cat. & rep.) 
         
  
       
 
        
        	[bookmark: pgfId-3533122]license
  
        	[bookmark: pgfId-3533127]Control
  
        	[bookmark: pgfId-3533132]URL Filtering
  
       
 
        
        	[bookmark: pgfId-3533134]devices
  
        	[bookmark: pgfId-3533139]Series 3
  
        	[bookmark: pgfId-3533144]Series 3
  
       
 
        
        	[bookmark: pgfId-3533149]Defense Centers
  
        	[bookmark: pgfId-3533151]Series 3, virtual
  
        	[bookmark: pgfId-3533153]Series 3, virtual
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3405524]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3410382]Controlling Encrypted Traffic Based on Application
 
     	 [bookmark: pgfId-3410385]Controlling Encrypted Traffic by URL Category and Reputation
 
    
 
     
      [bookmark: pgfId-3405841][bookmark: 86203]Controlling Encrypted Traffic Based on Application
 
     [bookmark: pgfId-3405957]License: Control
 
     [bookmark: pgfId-3451306]Supported Devices: Series 3
 
     [bookmark: pgfId-3469739]When the FireSIGHT System analyzes encrypted IP traffic, it can identify and classify commonly used encrypted applications on your network prior to decrypting the encrypted session. The system uses this discovery-based application awareness feature to allow you to control encrypted application traffic on your network. 
 
     [bookmark: pgfId-3469740]Application conditions in SSL rules allow you to perform this application control. Within a single SSL rule, there are a few ways you can specify applications whose traffic you want to control:
 
      
      	 [bookmark: pgfId-3469741]You can select individual applications, including custom applications.
 
      	 [bookmark: pgfId-3469745]You can use system-provided  application filters , which are named sets of applications organized according to its basic characteristics: type, risk, business relevance, and categories.
 
      	 [bookmark: pgfId-3469746]You can create and use custom application filters, which group applications (including custom applications) in any way you choose.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3557791]Note When you filter application traffic using access control rules, you can use application tags as a criterion. to filter. However, you cannot use application tags to filter encrypted traffic because there is no benefit. All applications that the system can detect in encrypted traffic are tagged SSL Protocol; applications without this tag can only be detected in unencrypted or decrypted traffic.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3557795]Application filters allow you to quickly create application conditions for SSL rules. They simplify policy creation and administration, and grant you assurance that the system will control web traffic as expected. For example, you could create an SSL rule that identifies and decrypts all high risk, low business relevance applications in encrypted traffic. If a user attempts to use one of those applications, the session is decrypted and inspected with access control.
 
     [bookmark: pgfId-3469751]In addition, Cisco frequently updates and adds additional detectors via system and vulnerability database (VDB) updates. You can also create your own detectors and assign characteristics (risk, relevance, and so on) to the applications they detect. By using filters based on application characteristics, you can ensure that the system uses the most up-to-date detectors to monitor application traffic.
 
     [bookmark: pgfId-3469752]For traffic to match an SSL rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list.
 
     [bookmark: pgfId-3533689]The following graphic shows the application condition for an SSL rule that decrypts a custom group of applications for MyCompany, all applications with high risk and low business relevance, gaming applications, and some individually selected applications.
 
     [bookmark: pgfId-3568627]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3469896]In a single application condition, you can add a maximum of 50 items to the Selected Applications and Filters list. Each of the following counts as an item:
 
      
      	 [bookmark: pgfId-3469897]One or more filters from the  Application Filters list, individually or in custom combination. This item represents set of applications, grouped by characteristic.
 
      	 [bookmark: pgfId-3469898]A filter created by saving search of the applications in the  Available Applications list. This item represents a set of applications, grouped by substring match.
 
      	 [bookmark: pgfId-3469899]An individual application from the  Available Applications list.
 
     
 
     [bookmark: pgfId-3469900]In the web interface, filters added to a condition are listed above and separately from individually added applications.
 
     [bookmark: pgfId-3469901]Note that when you apply an SSL policy, for each rule with an application condition, the system generates a list of unique applications to match. In other words, you may use overlapping filters and individually specified applications to ensure complete coverage.
 
     [bookmark: pgfId-3527845]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-3527895]Matching Encrypted Traffic with Application Filters
 
      	 [bookmark: pgfId-3527974]Matching Traffic from Individual Applications
 
      	 [bookmark: pgfId-3527986]Adding an Application Condition to an SSL Rule
 
      	 [bookmark: pgfId-3528157]Limitations to Encrypted Application Control
 
     
 
    
 
     
      [bookmark: pgfId-3469992][bookmark: 30464]Matching Encrypted Traffic with Application Filters
 
     [bookmark: pgfId-3504041]License: Control
 
     [bookmark: pgfId-3504048]Supported Devices: Series 3
 
     [bookmark: pgfId-3470013]When building an application condition in an SSL rule, use the Application Filters list to create a set of applications, grouped by characteristic, whose traffic you want to match. 
 
     [bookmark: pgfId-3470014]For your convenience, the system characterizes each application that it detects using the criteria described in Understanding Application Detection. You can use these criteria as filters or create custom combinations of filters to perform application control. 
 
     [bookmark: pgfId-3546083]Note that the mechanism for filtering applications within an SSL rule is the same as that for creating reusable, custom application filters using the object manager; see Working with Application Filters. You can also save many filters you create on-the-fly in access control rules as new, reusable filters. You cannot save a filter that includes another user-created filter because you cannot nest user-created filters.
 
     [bookmark: pgfId-3470070]Understanding How Filters Are Combined
 
     [bookmark: pgfId-3470071]When you select filters, singly or in combination, the Available Applications list updates to display only the applications that meet your criteria. You can select system-provided filters in combination, but not custom filters.
 
     [bookmark: pgfId-3470075]The system links multiple filters of the same filter type with an OR operation. For example, if you select the Medium and High filters under the Risks type, the resulting filter is:
 
      
      [bookmark: pgfId-3470076]Risk: Medium OR High 
     
 
     [bookmark: pgfId-3470077]If the Medium filter contained 110 applications and the High filter contained 82 applications, the system displays all 192 applications in the Available Applications list.
 
     [bookmark: pgfId-3470078]The system links different types of filters with an AND operation. For example, if you select the Medium and High filters under the Risks type, and the Medium and High filters under the Business Relevance type, the resulting filter is:
 
      
      [bookmark: pgfId-3470079]Risk: Medium OR High
AND
Business Relevance: Medium OR High 
     
 
     [bookmark: pgfId-3470080]In this case, the system displays only those applications that are included in both the Medium or High Risk type AND the Medium or High Business Relevance type.
 
     [bookmark: pgfId-3470081]Finding and Selecting Filters
 
     [bookmark: pgfId-3470082]To select filters, click the arrow next to a filter type to expand it, then select or clear the check box next to each filter whose applications you want to display or hide. You can also right-click a Cisco-provided filter type (Risks, Business Relevance, Types, or Categories) and select Check All or Uncheck All.
 
     [bookmark: pgfId-3470086]To search for filters, click the Search by name prompt above the Available Filters list, then type a name. The list updates as you type to display matching filters.
 
     [bookmark: pgfId-3470087]After you are done selecting filters, use the Available Applications list to add those filters to the rule; see Matching Traffic from Individual Applications.
 
    
 
     
      [bookmark: pgfId-3470092][bookmark: 60208]Matching Traffic from Individual Applications
 
     [bookmark: pgfId-3504077]License: Control
 
     [bookmark: pgfId-3504084]Supported Devices: Series 3
 
     [bookmark: pgfId-3470113]When building an application condition in an SSL rule, use the Available Applications list to select the applications whose traffic you want to match. 
 
     [bookmark: pgfId-3470114]Browsing the List of Applications
 
     [bookmark: pgfId-3470115]When you first start to build the condition the list is unconstrained, and displays every application the system detects, 100 at a time:
 
      
      	 [bookmark: pgfId-3470116]To page through the applications, click the arrows underneath the list. 
 
      	 [bookmark: pgfId-3470117]To display a pop-up window with summary information about the application’s characteristics, as well as Internet search links that you can follow, click the information icon (
 
      [image: ] ) next to an application. 
     
 
     [bookmark: pgfId-3470122][bookmark: 42058]Finding Applications to Match
 
     [bookmark: pgfId-3470123]To help you find the applications you want to match, you can constrain the Available Applications list in the following ways:
 
      
      	 [bookmark: pgfId-3470124]To search for applications, click the  Search by name prompt above the list, then type a name. The list updates as you type to display matching applications.
 
      	 [bookmark: pgfId-3470127]To constrain the applications by applying a filter, use the  Application Filters list (see Matching Encrypted Traffic with Application Filters). The  Available Applications list updates as you apply filters.
 
     
 
     [bookmark: pgfId-3470129]Once constrained, an All apps matching the filter option appears at the top of the Available Applications list. This option allows you to add all the applications in the constrained list to the Selected Applications and Filters list, all at once.
 
      
       
     
 
     
 
     [bookmark: pgfId-3470130]Note If you select one or more filters in the Application Filters list and also search the Available Applications list, your selections and the search-filtered Available Applications list are combined using an AND operation. That is, the All apps matching the filter condition includes all the individual conditions currently displayed in the Available Applications list as well as the search string entered above the Available Applications list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3470131]Selecting Single Applications to Match in a Condition
 
     [bookmark: pgfId-3470132]After you find an application you want to match, click to select it. To select multiple applications, use the Shift and Ctrl keys, or right-click and select Select All to select all applications in the current constrained view.
 
     [bookmark: pgfId-3470133]In a single application condition, you can match a maximum of 50 applications by selecting them individually; to add more than 50 you must either create multiple SSL rules or use filters to group applications.
 
     [bookmark: pgfId-3470134]Selecting All Applications Matching a Filter for a Condition
 
     [bookmark: pgfId-3470135]Once constrained by either searching or using the filters in the Application Filters list, the All apps matching the filter option appears at the top of the Available Applications list.
 
     [bookmark: pgfId-3470136]This option allows you to add the entire set of applications in the constrained Available Applications list to the Selected Applications and Filters list, at once. In contrast to adding applications individually, adding this set of applications counts as only one item against the maximum of 50, regardless of the number of individual application that comprise it.
 
     [bookmark: pgfId-3470137]When you build an application condition this way, the name of the filter you add to the Selected Applications and Filters list is a concatenation of the filter types represented in the filter plus the names of up to three filters for each type. More than three filters of the same type are followed by an ellipsis (...). For example, the following filter name includes two filters under the Risks type and four under Business Relevance:
 
      
      [bookmark: pgfId-3470138]Risks: Medium, High Business Relevance: Low, Medium, High,... 
     
 
     [bookmark: pgfId-3470139]Filter types that are not represented in a filter you add with All apps matching the filter are not included in the name of the filter you add. The instructional text that is displayed when you hover your pointer over the filter name in the Selected Applications and Filters list indicates that these filter types are set to any; that is, these filter types do not constrain the filter, so any value is allowed for these.
 
     [bookmark: pgfId-3546147]You can add multiple instances of All apps matching the filter to an application condition, with each instance counting as a separate item in the Selected Applications and Filters list. For example, you could add all high risk applications as one item, clear your selections, then add all low business relevance applications as another item. This application condition matches applications that are high risk OR have low business relevance.
 
    
 
     
      [bookmark: pgfId-3470142][bookmark: 67401]Adding an Application Condition to an SSL Rule
 
     [bookmark: pgfId-3504144]License: Control
 
     [bookmark: pgfId-3504151]Supported Devices: Series 3
 
     [bookmark: pgfId-3470163]For encrypted traffic to match an SSL rule with an application condition, the traffic must match one of the filters or applications that you add to a Selected Applications and Filters list. 
 
     [bookmark: pgfId-3470164]You can add a maximum of 50 items per condition, and filters added to a condition are listed above and separately from individually added applications. When building an application condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon.
 
     [bookmark: pgfId-3470168]To control encrypted application traffic:
 
     [bookmark: pgfId-3470172]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3470173]Step 1 In the SSL policy where you want to control traffic by application, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3470174]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3470175]Step 2 In the SSL rule editor, select the Applications tab.
 
     [bookmark: pgfId-3470176]The Applications tab appears.
 
     [bookmark: pgfId-3470177]Step 3 Optionally, use filters to constrain the list of applications displayed in the Available Applications list.
 
     [bookmark: pgfId-3470180]Select one or more filters in the Application Filters list. For more information, see Matching Encrypted Traffic with Application Filters.
 
     [bookmark: pgfId-3470182]Step 4 Find and select the applications you want to add from the Available Applications list.
 
     [bookmark: pgfId-3470183]You can search for and select individual applications, or, when the list is constrained, All apps matching the filter. For more information, see Matching Traffic from Individual Applications.
 
     [bookmark: pgfId-3470187]Step 5 Click Add to Rule to add the selected applications to the Selected Applications and Filters list. 
 
     [bookmark: pgfId-3470188]You can also drag and drop selected applications and filters. Filters appear under the heading Filters, and applications appear under the heading Applications.
 
      
       
     
 
     
 
     [bookmark: pgfId-3470189]Tip Before you add another filter to this application condition, click Clear All Filters to clear your existing selections.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3470198]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-3509634]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3470200]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3470359][bookmark: 26373]Limitations to Encrypted Application Control
 
     [bookmark: pgfId-3504180]License: Control
 
     [bookmark: pgfId-3504187]Supported Devices: Series 3
 
     [bookmark: pgfId-3470380]Keep the following points in mind when performing application control.
 
     [bookmark: pgfId-3470381]Encrypted Application Identification
 
     [bookmark: pgfId-3504257]The system can identify unencrypted applications that become encrypted using StartTLS. This includes such applications as SMTPS, POPS, FTPS, TelnetS, and IMAPS. In addition, it can identify certain encrypted applications based on the Server Name Indication in the TLS client hello message, or the server certificate subject distinguished name value.
 
     [bookmark: pgfId-3504205]Speed of Application Identification
 
     [bookmark: pgfId-3470382]The system cannot perform application control on encrypted traffic before:
 
      
      	 [bookmark: pgfId-3470383]an encrypted connection is established between a client and server, and 
 
      	 [bookmark: pgfId-3470384]the system identifies the application in the encrypted session
 
     
 ). 
     
 
     [bookmark: pgfId-3470387]After the system completes its identification, the system applies the SSL rule action to the remaining session traffic that matches its application condition.
 
     [bookmark: pgfId-3470393]Automatically Enabling Application Detectors
 
     [bookmark: pgfId-3470394]At least one detector must be enabled (see Activating and Deactivating Detectors) for each application rule condition in the policy. If no detector is enabled for an application, the system automatically enables all system-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.
 
    
 
     
      [bookmark: pgfId-3405889][bookmark: 23330]Controlling Encrypted Traffic by URL Category and Reputation
 
     [bookmark: pgfId-3405974]License: URL Filtering
 
     [bookmark: pgfId-3451389]Supported Devices: Series 3
 
     [bookmark: pgfId-3470488]URL conditions in SSL rules allow you to handle and decrypt encrypted website traffic that users on your network can access. The system detects the requested URL based on information passed during the SSL handshake. With a URL Filtering license, you can control access to websites based on the URL’s general classification, or category, and risk level, or reputation.
 
      
       
     
 
     
 
     [bookmark: pgfId-3550020]Note You can handle and decrypt traffic to specific URLs by defining a distinguished name SSL rule condition. The common name attribute in a certificate’s subject distinguished name contains the site’s URL. For more information, see Controlling Encrypted Traffic by Certificate Distinguished Name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3488358]For more information, see:
 
      
      	 [bookmark: pgfId-3470557]Performing Reputation-Based URL Blocking
 
      	 [bookmark: pgfId-3470560]Limitations on URL Detection and Blocking
 
     
 
    
 
     
      [bookmark: pgfId-3470563][bookmark: 91509]Performing Reputation-Based URL Blocking
 
     [bookmark: pgfId-3504750]License: URL Filtering
 
     [bookmark: pgfId-3504757]Supported Devices: Series 3
 
     [bookmark: pgfId-3470591]With a URL Filtering license, you can control your users’ access to websites based on the category and reputation of requested URLs:
 
      
      	 [bookmark: pgfId-3470592]The URL  category is a general classification for the URL. For example, ebay.com belongs to the  Auctions category, and monster.com belongs to the  Job Search category. A URL can belong to more than one category.
 
      	 [bookmark: pgfId-3470593]The URL  reputation represents how likely the URL is to be used for purposes that might be against your organization’s security policy. A URL’s risk can range from  High Risk (level 1) to  Well Known (level 5).
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-3570699] 
      Caution Adding or removing a URL category and reputation condition in an SSL rule restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-3470600]URL categories and reputations, which the FireSIGHT System obtains from the Cisco cloud, allow you to quickly create URL conditions for SSL rules. For example, you could create an SSL rule that identifies and blocks all High risk URLs in the Abused Drugs category. If a user attempts to browse to any URL with that category and reputation combination over an encrypted connection, the session is blocked.
 
      
       
     
 
     
 
     [bookmark: pgfId-3470601]Note Before SSL rules with category and reputation-based URL conditions can take effect, you must enable communications with the Cisco cloud. This allows the Defense Center to retrieve URL data. For more information, see Enabling Cloud Communications.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3470614]Using category and reputation data from the Cisco cloud simplifies policy creation and administration. It grants you assurance that the system controls encrypted web traffic as expected. Finally, because the cloud is continually updated with new URLs, as well as new categories and risks for existing URLs, you can ensure that the system uses up-to-date information to filter requested URLs. Malicious sites that represent security threats such as malware, spam, botnets, and phishing may appear and disappear faster than you can update and apply new policies.
 
     [bookmark: pgfId-3470615]For example:
 
      
      	 [bookmark: pgfId-3470616]If a rule blocks all gaming sites, as new domains get registered and classified as  Gaming , the system can block those sites automatically.
 
      	 [bookmark: pgfId-3470617]If a rule blocks all malware, and a blog page gets infected with malware, the cloud can recategorize the URL from  Blog to  Malware and the system can block that site.
 
      	 [bookmark: pgfId-3470618]If a rule blocks high-risk social networking sites, and somebody posts a link on their profile page that contains links to malicious payloads, the cloud can change the reputation of that page from  Benign sites to  High risk so the system can block it.
 
     
 
     [bookmark: pgfId-3547635]Note that if the cloud does not know the category or reputation of a URL, or if the Defense Center cannot contact the cloud, that URL does not trigger SSL rules with category or reputation-based URL conditions. You cannot assign categories or reputations to URLs manually.
 
     [bookmark: pgfId-3547636]The following graphic shows the URL condition for an access control rule that blocks: all malware sites, all high-risk sites, and all non-benign social networking sites.
 
     [bookmark: pgfId-3568651]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3473036]Tip If you decrypt traffic, then block it with access control, you can give users a chance to bypass the block by clicking through a warning page. See Interactive Blocking Actions: Allowing Users to Bypass Website Blocks for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3473001]You can add a maximum of 50 Selected Categories to match in a single URL condition. Each URL category, optionally qualified by reputation, counts as a single item.
 
     [bookmark: pgfId-3547302]The following table summarizes how you build the condition shown above. Note that you cannot qualify a literal URL or URL object with a reputation.
 
     [bookmark: pgfId-3547343]
 
      
       
        
        [bookmark: pgfId-3547308]Table 22-2 Example: Building A URL Condition 
 
        
        
         
         	 
           
           [bookmark: pgfId-3547314]To block... 
          
  
         	 
           
           [bookmark: pgfId-3547316]Select this Category or URL Object... 
          
  
         	 
           
           [bookmark: pgfId-3547318]And this Reputation... 
          
  
        
 
         
         	[bookmark: pgfId-3547320]malware sites, regardless of reputation
  
         	[bookmark: pgfId-3547322]Malware Sites
  
         	[bookmark: pgfId-3547324]Any
  
        
 
         
         	[bookmark: pgfId-3547326]any URL with a high risk (level 1)
  
         	[bookmark: pgfId-3547328]Any
  
         	[bookmark: pgfId-3547330]1 - High Risk
  
        
 
         
         	[bookmark: pgfId-3547332]social networking sites with a risk greater than benign (levels 1 through 3)
  
         	[bookmark: pgfId-3547334]Social Network
  
         	[bookmark: pgfId-3547336]3 - Benign sites with security risks
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3547344]When building a URL condition, warning icons indicate invalid configurations. For details, hover your pointer over the icon and see Troubleshooting Access Control Policies and Rules.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-3570418] 
      Caution Adding or removing a URL category and reputation condition in an SSL rule restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-3470677]To control traffic by requested URL using category and reputation data:
 
     [bookmark: pgfId-3470681]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3470682]Step 1 In the SSL policy where you want to control encrypted traffic by URL, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3470683]For detailed instructions, see Understanding and Creating SSL Rules.
 
     [bookmark: pgfId-3470684]Step 2 In the SSL rule editor, select the Categories tab.
 
     [bookmark: pgfId-3470685]The Categories tab appears.
 
     [bookmark: pgfId-3470686]Step 3 Find and select the categories of URL you want to add from the Categories list. To match encrypted web traffic regardless of category, select Any category.
 
     [bookmark: pgfId-3470687]To search for categories to add, click the Search by name or value prompt above the Categories list, then type the category name. The list updates as you type to display matching categories.
 
     [bookmark: pgfId-3470688]To select a category, click it. To select multiple categories, use the Shift and Ctrl keys. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3470689]Tip Although you can right-click and Select All categories, adding all categories this way exceeds the 50-item maximum for an SSL rule. Instead, use Any.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3470690]Step 4 Optionally, qualify your category selections by clicking a reputation level from the Reputations list. If you do not specify a reputation level, the system defaults to Any, meaning all levels. 
 
     [bookmark: pgfId-3470691]You can only select one reputation level. When you choose a reputation level, the SSL rule behaves differently depending on its purpose:
 
      
       
       	 [bookmark: pgfId-3474254]If the rule blocks web access or decrypts traffic (the rule action is Block ,  Block with reset ,  Decrypt - Known Key ,  Decrypt - Resign , or  Monitor ) selecting a reputation level also selects all reputations more severe than that level. For example, if you configure a rule to block  Suspicious sites (level 2), it also automatically blocks  High Risk (level 1) sites.
 
       	 [bookmark: pgfId-3470693]If the rule allows web access, subject to access control (the rule action is  Do not decrypt ), selecting a reputation level also selects all reputations less severe than that level. For example, if you configure a rule to allow  Benign sites (level 4), it also automatically allows  Well known (level 5) sites.
 
      
 
     
 
     [bookmark: pgfId-3473009]If you change the rule action for a rule, the system automatically changes the reputation levels in URL conditions according to the above points.
 
     [bookmark: pgfId-3473010]Step 5 Click Add to Rule or to add the selected items to the Selected Categories list. 
 
     [bookmark: pgfId-3473011]You can also drag and drop selected items.
 
     [bookmark: pgfId-3473004]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-3509650]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3473006]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3470760][bookmark: 88336][bookmark: 12501]Limitations on URL Detection and Blocking
 
     [bookmark: pgfId-3470764]License: URL Filtering
 
     [bookmark: pgfId-3470777]Supported Devices: Series 3
 
     [bookmark: pgfId-3470778]Keep the following points in mind when performing URL detection and blocking.
 
     [bookmark: pgfId-3470779]Speed of URL Identification
 
     [bookmark: pgfId-3470780]The system cannot categorize URLs before:
 
      
      	 [bookmark: pgfId-3470781]a monitored connection is established between a client and server
 
      	 [bookmark: pgfId-3470782]the system identifies the HTTPS application in the session
 
      	 [bookmark: pgfId-3470783]the system identifies the requested URL from either the client hello message or the server certificate
 
     
 ). 
     
 
     [bookmark: pgfId-3569094]After the system completes its identification, the system applies the SSL rule action to the remaining session traffic that matches its URL condition.
 
     [bookmark: pgfId-3571314]Due to memory limitations, some device models perform URL filtering with a smaller, less granular, set of categories and reputations. For example, if a parent URL's subsites have different URL categories and reputations, some devices may use the parent URL's data for all subsites. As a specific example, the system might evaluate mail.google.com using the google.com category and reputation. Affected devices include the 71xx Family and the following ASA models: ASA5506-X, ASA5506H-X, ASA5506W-X, ASA5508-X, ASA5512-X, ASA5515-X, ASA5516-X, and ASA5525-X.
 
     [bookmark: pgfId-3569659]For virtual devices, see the installation guide for information on allocating the correct amount of memory to perform category and reputation-based URL filtering. 
 
     [bookmark: pgfId-3569095]Search Query Parameters in URLs
 
     [bookmark: pgfId-3470789]The system does not use search query parameters in the URL to match URL conditions. For example, consider a scenario where you block all shopping traffic. In that case, using a web search to search for amazon.com is not blocked, but browsing to amazon.com is.
 
    
 
   
 
    
     [bookmark: pgfId-3405442][bookmark: 34380]Controlling Traffic Based on Encryption[bookmark: marker-3423966] Properties
 
    [bookmark: pgfId-3405531]License: Any
 
    [bookmark: pgfId-3451437]Supported Devices: Series 3
 
    [bookmark: pgfId-3405541]You can create SSL rules that handle and decrypt encrypted traffic based on encrypted connection characteristics. You can detect the protocol version or cipher suite used to encrypt the session, and handle traffic accordingly. You can also detect the server certificate and handle traffic, based on the following certificate characteristics:
 
     
     	 [bookmark: pgfId-3485183]the server certificate itself
 
     	 [bookmark: pgfId-3485236]the certificate issuer, whether an issuing CA or if the certificate is self-signed
 
     	 [bookmark: pgfId-3485322]the certificate holder
 
     	 [bookmark: pgfId-3485346]various certificate statuses, such as whether the certificate is valid, or revoked by the issuing CA
 
    
 
    [bookmark: pgfId-3483492]To detect multiple cipher suites in a rule, the certificate issuer, or the certificate holder, you can create reusable cipher suite list and distinguished name objects and add them to your rule. To detect the server certificate and certain certificate statuses, you must create external certificate and external CA objects for the rule. 
 
    [bookmark: pgfId-3405985]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3410536]Controlling Encrypted Traffic by Certificate Distinguished Name
 
     	 [bookmark: pgfId-3410545]Controlling Encrypted Traffic by Certificate
 
     	 [bookmark: pgfId-3410557]Controlling Encrypted Traffic by Certificate Status
 
     	 [bookmark: pgfId-3410560]Controlling Encrypted Traffic by Cipher Suite
 
     	 [bookmark: pgfId-3505332]Controlling Traffic by Encryption Protocol Version
 
    
 
     
      [bookmark: pgfId-3505381][bookmark: 58389]Controlling Encrypted Traffic by Certificate Distinguished Name
 
     [bookmark: pgfId-3505388]License: Any
 
     [bookmark: pgfId-3505395]Supported Devices: Series 3
 
     [bookmark: pgfId-3505404]Distinguished name conditions in SSL rules allow you to handle and inspect encrypted traffic based on the CA that issued a server certificate, or the certificate holder. Based on the issuer distinguished name, you can handle traffic based on the CA that issued a site’s server certificate. 
 
     [bookmark: pgfId-3505405]When configuring the rule condition, you can manually specify a literal value, reference a distinguished name object, or reference a distinguished name group containing multiple objects.
 
      
       
     
 
     
 
     [bookmark: pgfId-3505406]Note You cannot configure a distinguished name condition if you also select the Decrypt - Known Key action. Because that action requires you to select a server certificate to decrypt traffic, the certificate already matches the traffic. See Decrypt Actions: Decrypting Traffic for Further Inspection for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3505407]You can match against multiple subject and issuer distinguished names in a single certificate status rule condition; only one common or distinguished name needs to match to match the rule. 
 
     [bookmark: pgfId-3505408]If you add a distinguished name manually, it can contain the common name attribute (CN). If you add a common name without CN= then the system prepends CN= before saving the object.
 
      
       
        
        [bookmark: pgfId-3505411]Table 22-3 Distinguished Name Attributes
 
        
        
         
         	 
           
           [bookmark: pgfId-3505417]Attribute 
          
  
         	 
           
           [bookmark: pgfId-3505419]Description 
          
  
         	 
           
           [bookmark: pgfId-3505421]Allowed Values 
          
  
        
 
         
         	[bookmark: pgfId-3505423]C
  
         	[bookmark: pgfId-3505425]Country Code
  
         	[bookmark: pgfId-3505427]two alphabetic characters
  
        
 
         
         	[bookmark: pgfId-3505429]CN
  
         	[bookmark: pgfId-3505431]Common Name
  
         	 [bookmark: pgfId-3505433]up to 64 alphanumeric, backslash (\), hyphen (-), quotation ("), asterisk (*), period (.), or space characters
  
        
 
         
         	[bookmark: pgfId-3505435]O
  
         	[bookmark: pgfId-3505437]Organization
  
        
 
         
         	[bookmark: pgfId-3505441]OU
  
         	[bookmark: pgfId-3505443]Organizational Unit
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3505447]The following graphic illustrates a distinguished name rule condition searching for certificates issued to goodbakery.example.com or issued by goodca.example.com. Traffic encrypted with these certificates is allowed, subject to access control.
 
     [bookmark: pgfId-3568675]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3505465]You can add a maximum of 50 literal values and distinguished name objects to the Subject DNs, and 50 literal values and distinguished name objects to the Issuer DNs, in a single DN condition.
 
     [bookmark: pgfId-3537133]The system-provided DN object group, Sourcefire Undecryptable Sites, contains websites whose traffic the system cannot decrypt. You can add this group to a DN condition to block or not decrypt traffic to or from these websites, without wasting system resources attempting to decrypt that traffic. You can modify individual entries in the group. You cannot delete the group. System updates can modify the entries on this list, but the system preserves user changes.
 
     [bookmark: pgfId-3537134]To inspect encrypted traffic based on certificate subject or issuer distinguished name:
 
     [bookmark: pgfId-3505470]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3505471]Step 1 In the SSL policy where you want to control encrypted traffic by certificate subject or issuer distinguished name, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3505475]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3505476]Step 2 In the SSL rule editor, select the DN tab.
 
     [bookmark: pgfId-3505477]The DN tab appears.
 
     [bookmark: pgfId-3505478]Step 3 Find and select the distinguished names you want to add from the Available DNs, as follows:
 
      
       
       	 [bookmark: pgfId-3505479]To add a distinguished name object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available DNs  list; see 
      Working with Distinguished Name Objects. 
     
 
      
       
       	 [bookmark: pgfId-3505483]To search for distinguished name objects and groups to add, click the  Search by name or value  prompt above the  Available DNs  list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3505484]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3505485]Step 4 You have the following options:
 
      
       
       	 [bookmark: pgfId-3505486]Click  Add to Subject to add the selected objects to the  Subject DNs  list. 
 
       	 [bookmark: pgfId-3505487]Click  Add to Issuer to add the selected objects to the  Issuer DNs  list. 
 
      
 
     
 
     [bookmark: pgfId-3505488]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3505489]Step 5 Add any literal common names or distinguished names that you want to specify manually.
 
     [bookmark: pgfId-3505490]Click the Enter DN or CN prompt below the Subject DNs or Issuer DNs list; then type a common name or distinguished name and click Add.
 
     [bookmark: pgfId-3505491]Step 6 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509670]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3505499]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3505334][bookmark: 28093]Controlling Encrypted Traffic by Certificate 
 
     [bookmark: pgfId-3505341]License: Any
 
     [bookmark: pgfId-3451474]Supported Devices: Series 3
 
     [bookmark: pgfId-3415927]Certificate conditions in SSL rules allow you to handle and inspect encrypted traffic based on the server certificate used to encrypt that traffic. You can configure a condition with one or more certificates; traffic matches the rule if the certificate matches any of the condition’s certificates.
 
     [bookmark: pgfId-3474793]When you build a certificate-based SSL rule condition, you can upload a server certificate; you save the certificate as an external certificate object, which is reusable and associates a name with a server certificate. Alternately, you can configure certificate conditions with existing external certificate objects and object groups.
 
     [bookmark: pgfId-3474784]You can search the Available Certificates field in the rule condition based for external certificate objects and object groups based on the following certificate distinguished name characteristics:
 
      
      	 [bookmark: pgfId-3449137]subject or issuer common name (CN)
 
      	 [bookmark: pgfId-3449185]subject or issuer organization (O)
 
      	 [bookmark: pgfId-3449231]subject or issuer organizational unit (OU)
 
     
 
     [bookmark: pgfId-3449038]You can choose to match against multiple certificates in a single certificate rule condition; if the certificate used to encrypt the traffic matches any of the uploaded certificates, the encrypted traffic matches the rule. 
 
     [bookmark: pgfId-3480353]You can add a maximum of 50 external certificate objects and external certificate object groups to the Selected Certificates in a single certificate condition.
 
     [bookmark: pgfId-3519536]Note the following:
 
      
      	 [bookmark: pgfId-3519592]You cannot configure a certificate condition if you also select the  Decrypt - Known Key action. Because that action requires you to select a server certificate to decrypt traffic, the implication is that the certificate already matches the traffic. See Decrypt Actions: Decrypting Traffic for Further Inspection for more information.
 
      	 [bookmark: pgfId-3520613]If you configure a certificate condition with an external certificate object, any cipher suites you add to a cipher suite condition, or internal CA objects you associate with the  Decrypt - Resign action, must match the external certificate’s signature algorithm type. For example, if your rule’s certificate condition references an EC-based server certificate, any cipher suites you add, or CA certificates you associate with the  Decrypt - Resign action, must also be EC-based. If you mismatch signature algorithm types in this case, the policy editor displays a warning icon next to the rule. For more information, see Controlling Encrypted Traffic by Cipher Suite and Decrypt Actions: Decrypting Traffic for Further Inspection.
 
     
 
     [bookmark: pgfId-3449799]To inspect encrypted traffic based on server certificate:
 
     [bookmark: pgfId-3449800]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3449801]Step 1 In the SSL policy where you want to control encrypted traffic based on server certificate, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3449804]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3449806]Step 2 In the SSL rule editor, select the Certificate tab.
 
     [bookmark: pgfId-3449807]The Certificate tab appears.
 
     [bookmark: pgfId-3449808]Step 3 Find and select the server certificates you want to add from the Available Certificates, as follows;
 
      
       
       	 [bookmark: pgfId-3449809]To add an external certificate object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Certificates list; see 
      Working with External Certificate Objects. 
     
 
      
       
       	 [bookmark: pgfId-3449813]To search for certificate objects and groups to add, click the  Search by name or value  prompt above the  Available Certificates  list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3449814]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3449816]Step 4 Click Add to Rule to add the selected objects to the Subject Certificates list. 
 
     [bookmark: pgfId-3449818]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3449821]Step 5 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509716]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3462159]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3406065][bookmark: 32205]Controlling Encrypted Traffic by Certificate Status
 
     [bookmark: pgfId-3415826]License: Any
 
     [bookmark: pgfId-3451520]Supported Devices: Series 3
 
     [bookmark: pgfId-3439403]Certificate status conditions in SSL rules allow you to handle and inspect encrypted traffic based on the status of the server certificate used to encrypt the traffic, including whether a certificate is valid, revoked, expired, not yet valid, self-signed, or signed by a trusted CA. 
 
     [bookmark: pgfId-3439957]Checking whether a CA issued or revoked a certificate requires uploading root and intermediate CA certificates and associated CRLs as objects. You then add these trusted CA objects to an SSL policy’s list of trusted CA certificates.
 
     [bookmark: pgfId-3440150]For each certificate status SSL rule condition you configure, you can match traffic against the presence or absence of a given status. You can select several statuses in one rule condition; if the certificate matches any of the selected statuses, the rule matches the traffic. 
 
     [bookmark: pgfId-3418899]For more information, see:
 
      
      	 [bookmark: pgfId-3420347]Trusting External Certificate Authorities
 
      	 [bookmark: pgfId-3420370]Matching Traffic on Certificate Status
 
     
 
    
 
     
      [bookmark: pgfId-3410843][bookmark: 22445]Trusting External Certificate [bookmark: marker-3423951]Authorities
 
     [bookmark: pgfId-3410844]License: Any
 
     [bookmark: pgfId-3451542]Supported Devices: Series 3
 
     [bookmark: pgfId-3410848]You can trust CAs by adding root and intermediate CA certificates to your SSL policy, then use these trusted CAs to verify server certificates used to encrypt traffic. Verified server certificates include certificates signed by trusted CAs.
 
     [bookmark: pgfId-3424967]If a trusted CA certificate contains an uploaded certificate revocation list (CRL), you can also verify whether a trusted CA revoked the encryption certificate. See Adding a Certificate Revocation List to a Trusted CA Object for more information.
 
     [bookmark: pgfId-3420885]After you add trusted CA certificates to the SSL policy, you can configure an SSL rule with various Certificate Status conditions to match against this traffic. See Working with Trusted Certificate Authority Objects and Controlling Encrypted Traffic by Certificate Status for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-3421833]Tip Upload all certificates within a root CA’s chain of trust to the list of trusted CA certificates, including the root CA certificate and all intermediate CA certificates. Otherwise, it is more difficult to detect trusted certificates issued by intermediate CAs.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3410946]When you create an SSL policy, the system populates the Trusted CA Certificates tab with a default Trusted CA object group, Sourcefire Trusted Authorities. You can modify individual entries in the group, and choose whether to include this group in your SSL policy. You cannot delete the group. System updates can modify the entries on this list, but user changes are preserved. See Creating a Basic SSL Policy for more information.
 
     [bookmark: pgfId-3410950]To add trusted CAs to your policy:
 
     [bookmark: pgfId-3410951]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3410952]Step 1 Select Policies > SSL.
 
     [bookmark: pgfId-3410953]The SSL Policy page appears.
 ) next to the SSL policy you want to configure. 
     
 
     [bookmark: pgfId-3410958]The SSL policy editor appears.
 
     [bookmark: pgfId-3410959]Step 3 Select the Trusted CA Certificates tab. 
 
     [bookmark: pgfId-3410960]The Trusted CA Certificates page appears. 
 
     [bookmark: pgfId-3529109]Step 4 Find and select the trusted CAs you want to add from the Available Trusted CAs, as follows:
 
      
       
       	 [bookmark: pgfId-3529110]To add a trusted CA object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Trusted CAs  list; see 
      Working with Trusted Certificate Authority Objects. 
     
 
      
       
       	 [bookmark: pgfId-3529117]To search for trusted CA objects and groups to add, click the  Search by name or value  prompt above the  Available Trusted CAs  list, then type either the name of the object, or a value in the object. The list updates as you type to display matching objects.
 
      
 
     
 
     [bookmark: pgfId-3529118]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3529314]Step 5 Click Add to Rule to add the selected objects to the Selected Trusted CAs list. 
 
     [bookmark: pgfId-3529315]You can also drag and drop selected objects.
 
     [bookmark: pgfId-3410971]Step 6 Add or continue editing the rule.
 
     [bookmark: pgfId-3509740]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3462200]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3419893][bookmark: 18728]Matching Traffic on Certificate Status
 
     [bookmark: pgfId-3420062]License: Any
 
     [bookmark: pgfId-3451581]Supported Devices: Series 3
 
     [bookmark: pgfId-3420721]Based on the certificate status rule condition configuration, you can match encrypted traffic based on the status of the server certificate used to encrypt traffic. You can:
 
      
      	 [bookmark: pgfId-3429110]check for a server certificate status
 
      	 [bookmark: pgfId-3429203]check that a certificate does not have a status
 
      	 [bookmark: pgfId-3429290]skip checking for the presence or absence of a certificate status 
 
     
 
     [bookmark: pgfId-3429102]You can choose to match against the presence or absence of multiple certificate statuses in a single certificate status rule condition; the certificate needs to only match one of the criteria to match the rule. 
 
      
       
        
        [bookmark: pgfId-3420389]Table 22-4 Certificate Status Rule Condition Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-3420393]Status Check 
          
  
         	 
           
           [bookmark: pgfId-3420395]Status Set to Yes 
          
  
         	 
           
           [bookmark: pgfId-3425645]Status Set to No 
          
  
        
 
         
         	[bookmark: pgfId-3420397]Revoked
  
         	[bookmark: pgfId-3420399]The policy trusts the CA that issued the server certificate, and the CA certificate uploaded to the policy contains a CRL that revokes the server certificate. 
  
         	[bookmark: pgfId-3425647]The policy trusts the CA that issued the server certificate, and the CA certificate uploaded to the policy does not contain a CRL that revokes the certificate.
  
        
 
         
         	[bookmark: pgfId-3420401]Self-signed
  
         	[bookmark: pgfId-3420403]The detected server certificate contains the same subject and issuer distinguished name.
  
         	[bookmark: pgfId-3425649]The detected server certificate contains different subject and issuer distinguished names.
  
        
 
         
         	[bookmark: pgfId-3420405]Valid
  
         	[bookmark: pgfId-3547115]All of the following are true:
 
           
           	 [bookmark: pgfId-3547116]The policy trusts the CA that issued the certificate
 
           	 [bookmark: pgfId-3524093]The signature is valid
 
           	 [bookmark: pgfId-3524124]The issuer is valid
 
           	 [bookmark: pgfId-3426986]None of the policy’s trusted CAs revoked the certificate.
 
           	 [bookmark: pgfId-3427009]The current date is between the certificate Valid From and Valid To date
 
          
  
         	[bookmark: pgfId-3425651]At least one of the following is true:
 
           
           	 [bookmark: pgfId-3427604]The policy does not trust the CA that issued the certificate
 
           	 [bookmark: pgfId-3524152]The signature is invalid
 
           	 [bookmark: pgfId-3524190]The issuer is invalid
 
           	 [bookmark: pgfId-3427605]A trusted CA in the policy revoked the certificate
 
           	 [bookmark: pgfId-3427593]The current date is before the certificate Valid From date
 
           	 [bookmark: pgfId-3426583]The current date is after the certificate Valid To date
 
          
  
        
 
         
         	[bookmark: pgfId-3420409]Invalid signature
  
         	[bookmark: pgfId-3420411]The certificate’s signature cannot be properly validated against the certificate’s content.
  
         	[bookmark: pgfId-3425653]The certificate’s signature is properly validated against the certificate’s content.
  
        
 
         
         	[bookmark: pgfId-3420413]Invalid issuer
  
         	[bookmark: pgfId-3420415]The issuer CA certificate is not stored in the policy’s list of trusted CA certificates. 
  
         	[bookmark: pgfId-3529704]The issuer CA certificate is stored in the policy’s list of trusted CA certificates. 
  
        
 
         
         	[bookmark: pgfId-3420417]Expired
  
         	[bookmark: pgfId-3420419]The current date is after the certificate Valid To date.
  
         	[bookmark: pgfId-3425657]The current date is before or on the certificate Valid To date.
  
        
 
         
         	[bookmark: pgfId-3420421]Not yet valid
  
         	[bookmark: pgfId-3420423]The current date is before the certificate Valid From date.
  
         	[bookmark: pgfId-3425659]The current date is after or on the certificate Valid From date.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3429580]Consider the following example. The organization trusts the Verified Authority certificate authority. The organization does not trust the Spammer Authority certificate authority. The system administrator uploads the Verified Authority certificate and an intermediate CA certificate issued by Verified Authority to the system. Because Verified Authority revoked a certificate it previously issued, the system administrator uploads the CRL that Verified Authority distributed. 
 
     [bookmark: pgfId-3529904]The following graphic illustrates a certificate status rule condition checking for valid certificates, those issued by Verified Authority, not on the CRL, and still within the Valid From and Valid To date. Because of the configuration, traffic encrypted with these certificates is not decrypted and inspected with access control.
 
     [bookmark: pgfId-3568723]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3433893]Note that even though a certificate may match more than one status, the rule only takes an action on the traffic once. 
 
     [bookmark: pgfId-3479635]To inspect encrypted traffic by server certificate status:
 
     [bookmark: pgfId-3438880]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3438911]Step 1 In the SSL policy where you want to control encrypted traffic based on server certificate status, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3438914]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3438916]Step 2 In the SSL rule editor, select the Cert Status tab.
 
     [bookmark: pgfId-3438917]The Cert Status tab appears.
 
     [bookmark: pgfId-3438975]Step 3 For each certificate status, you have the following options:
 
      
       
       	 [bookmark: pgfId-3439026]Select  Yes to match against the presence of that certificate status.
 
       	 [bookmark: pgfId-3439119]Select  No to match against the absence of that certificate status.
 
       	 [bookmark: pgfId-3439179]Select  Do Not Match to not match that certificate status. 
 
      
 
     
 
     [bookmark: pgfId-3439316]Step 4 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509768]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3462211]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3406107][bookmark: 85738]Controlling Encrypted Traffic by Cipher Suite
 
     [bookmark: pgfId-3415797]License: Any
 
     [bookmark: pgfId-3451600]Supported Devices: Series 3
 
     [bookmark: pgfId-3410070]Cipher suite conditions in SSL rules allow you to handle and inspect encrypted traffic based on the cipher suite used to negotiate the encrypted session. Cisco provides predefined cipher suites you can add to a cipher suite rule condition. You can also add cipher suite list objects containing multiple cipher suites. For more information on cipher suite lists, see Working with Cipher Suite Lists. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3519382]Note You cannot add new cipher suites. You can neither modify nor delete predefined cipher suites. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3417786]You can add a maximum of 50 cipher suites and cipher suite lists to the Selected Cipher Suites in a single Cipher Suite condition.
 
     [bookmark: pgfId-3521510]Note the following:
 
      
      	 [bookmark: pgfId-3521585]If you add cipher suites not supported for your deployment, you cannot apply the access control policy associated with the SSL policy. For example, passive deployments do not support decrypting traffic with the any of the ephemeral Diffie-Hellman (DHE) or ephemeral elliptic curve Diffie-Hellman (ECDHE) cipher suites. Creating a rule with these cipher suites prevents you from applying your access control policy. 
 
      	 [bookmark: pgfId-3521577]If you configure a cipher suite condition with a cipher suite, any external certificate objects you add to a certificate condition, or internal CA objects you associate with the  Decrypt - Resign action, must match the cipher suite’s signature algorithm type. For example, if your rule’s cipher suite condition references an EC-based cipher suite, any server certificates you add, or CA certificates you associate with the  Decrypt - Resign action, must also be EC-based. If you mismatch signature algorithm types in this case, the policy editor displays a warning icon next to the rule. For more information, see Controlling Encrypted Traffic by Cipher Suite and Decrypt Actions: Decrypting Traffic for Further Inspection.
 
      	 [bookmark: pgfId-3536135]The system cannot decrypt traffic encrypted with an anonymous cipher suite. You cannot use either the Decrypt - Resign or  Decrypt - Known Key action in an SSL rule if you add an anonymous cipher suite to the  Cipher Suite condition. 
 
     
 
     [bookmark: pgfId-3418361]To inspect encrypted traffic by cipher suite:
 
     [bookmark: pgfId-3418468]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3418474]Step 1 In the SSL policy where you want to control encrypted traffic by cipher suite, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3418477]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3418479]Step 2 In the SSL rule editor, select the Cipher Suite tab.
 
     [bookmark: pgfId-3418480]The Cipher Suite tab appears.
 
     [bookmark: pgfId-3418526]Step 3 Find and select the cipher suites you want to add from the Available Cipher Suites, as follows;
 
      
       
       	 [bookmark: pgfId-3418638]To add a cipher suite list on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Cipher Suites  list; see 
      Working with Cipher Suite Lists. 
     
 
      
       
       	 [bookmark: pgfId-3418645]To search for cipher suites and lists to add, click the  Search by name or value  prompt above the  Available Cipher Suites  list, then type either the name of the cipher suite, or a value in the cipher suite. The list updates as you type to display matching cipher suites.
 
      
 
     
 
     [bookmark: pgfId-3418646]To select a cipher suite, click it. To select multiple cipher suites, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-3418744]Step 4 Click Add to Rule to add the selected cipher suites to the Selected Cipher Suites list. 
 
     [bookmark: pgfId-3418745]You can also drag and drop selected cipher suites.
 
     [bookmark: pgfId-3418786]Step 5 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509817]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3462233]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3406143][bookmark: 40214]Controlling Traffic by Encryption Protocol Version
 
     [bookmark: pgfId-3406304]License: Any
 
     [bookmark: pgfId-3451628]Supported Devices: Series 3
 
     [bookmark: pgfId-3410085]Session conditions in SSL rules allow you to inspect encrypted traffic based on the SSL or TLS version used to encrypt the traffic. You can choose to match against traffic encrypted with SSL version 3.0, or TLS version 1.0, 1.1, or 1.2. By default, all protocol versions are selected when you create a rule; if you select multiple versions, encrypted traffic that matches any of the selected versions matches the rule. You must select at least one protocol version when saving the rule condition.
 
      
       
     
 
     
 
     [bookmark: pgfId-3478544]Note You cannot select SSL v2.0 in a version rule condition; the system does not support decrypting traffic encrypted with SSL version 2.0. You can configure an undecryptable action to allow or block this traffic without further inspection. For more information, see Logging Decryptable Connections with SSL Rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3415110]To inspect encrypted traffic by SSL or TLS version:
 
     [bookmark: pgfId-3415144]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-3415184]Step 1 In the SSL policy where you want to control encrypted traffic by encryption protocol version, create a new SSL rule or edit an existing rule.
 
     [bookmark: pgfId-3415284]For detailed instructions, see Understanding and Creating SSL Rules. 
 
     [bookmark: pgfId-3415326]Step 2 In the SSL rule editor, select the Version tab.
 
     [bookmark: pgfId-3415372]The Version tab appears.
 
     [bookmark: pgfId-3415400]Step 3 Select the protocol versions you want to match against: SSL v3.0, TLS v1.0, TLS v1.1, or TLS v1.2.
 
     [bookmark: pgfId-3415540]Step 4 Add or continue editing the rule. 
 
     [bookmark: pgfId-3509836]You must apply the access control policy associated with the SSL policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-3462242]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3351539]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 19322]Understanding Network Analysis and Intrusion Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1543216]Network analysis and intrusion policies work together as part of the FireSIGHT System’s intrusion detection and prevention feature. The term intrusion detection generally refers to the process of passively analyzing network traffic for potential intrusions and storing attack data for security analysis. The term intrusion prevention includes the concept of intrusion detection, but adds the ability to block or alter malicious traffic as it travels across your network.
 
    [bookmark: pgfId-1555135]In an intrusion prevention deployment, when the system examines packets:
 
     
     	 [bookmark: pgfId-1555136]A  network analysis policy governs how traffic is  decoded and  preprocessed so that it can be further evaluated, especially for anomalous traffic that might signal an intrusion attempt.
 
     	 [bookmark: pgfId-1544078]An  intrusion policy uses  intrusion and preprocessor rules (sometimes referred to collectively as  intrusion rules ) to examine the decoded packets for attacks based on patterns. Intrusion policies are paired with  variable sets , which allow you to use named values to accurately reflect your network environment.
 
    
 
    [bookmark: pgfId-1544177]Both network analysis and intrusion policies are invoked by a parent access control policy, but at different times. As the system analyzes traffic, the network analysis (decoding and preprocessing) phase occurs before and separately from the intrusion prevention (additional preprocessing and intrusion rules) phase. Together, network analysis and intrusion policies provide broad and deep packet inspection. They can help you detect, alert on, and protect against network traffic that could threaten the availability, integrity, and confidentiality of hosts and their data.
 
    [bookmark: pgfId-1544402]The FireSIGHT System is delivered with several similarly named network analysis and intrusion policies (for example, Balanced Security and Connectivity) that complement and work with each other. By using system-provided policies, you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states, as well as provides the initial configurations for preprocessors and other advanced settings.
 
    [bookmark: pgfId-1544590]You can also create custom network analysis and intrusion policies. You can tune settings in custom policies to inspect traffic in the way that matters most to you so that you can improve both the performance of your managed devices and your ability to respond effectively to the events they generate.
 
    [bookmark: pgfId-1571610]You create, edit, save, and manage network analysis and intrusion policies using similar policy editors in the web interface. When you are editing either type of policy, a navigation panel appears on the left side of the web interface; the right side displays various configuration pages.
 
    [bookmark: pgfId-1571630]This chapter contains a brief overview of the types of configurations the network analysis and intrusion policies govern, explains how the policies work together to examine traffic and generate records of policy violations, and provides basic information on navigating the policy editors. This chapter also explains the benefits and limitations of using custom versus system-provided policies. For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1546715]Understanding How Policies Examine Traffic For Intrusions
 
     	 [bookmark: pgfId-1565214]Comparing System-Provided with Custom Policies
 
     	 [bookmark: pgfId-1565153]Using the Navigation Panel
 
     	 [bookmark: pgfId-1565158]Resolving Conflicts and Committing Policy Changes
 
    
 
    [bookmark: pgfId-1576133]To customize your intrusion deployment, see the following for your next steps:
 
     
     	 [bookmark: pgfId-1580974]Working with Variable Sets explains how to configure the system’s intrusion variables to accurately reflect your network environment. Even if you do not use custom policies, Cisco  strongly recommends you modify the default variables in the default variable set. Advanced users can create and use custom variable sets for pairing with one or more custom intrusion policies.
 
     	 [bookmark: pgfId-1580952]Getting Started with Intrusion Policies explains how to create and edit a simple custom intrusion policy.
 
     	 [bookmark: pgfId-1576073]Controlling Traffic Using Intrusion and File Policies explains how to configure the system to use intrusion policies to examine only the traffic you are interested in, by associating intrusion policies with a parent access control policy. It also explains how to configure advanced intrusion policy performance options.
 
     	 [bookmark: pgfId-1580584]Configuring Advanced Transport/Network Settings explains how to configure advanced transport and network preprocessor settings that apply globally to all traffic handled by the target devices of an access control policy. You configure these advanced settings in an access control policy rather than in a network analysis or intrusion policy.
 
     	 [bookmark: pgfId-1576077]Getting Started with Network Analysis Policies explains how to create and edit a simple custom network analysis policy.
 
     	 [bookmark: pgfId-1572937]Customizing Preprocessing with Network Analysis Policies explains how to change the default network analysis policy. For advanced users, this section also explains how to tailor preprocessing to specific security zones, networks, and VLANs by assigning custom network analysis policies to preprocess matching traffic.
 
     	 [bookmark: pgfId-1599893]Using Layers in a Network Analysis or Intrusion Policy explain how, in larger organizations or complex deployments, you can use building blocks called policy  layers  to more efficiently manage multiple network analysis or intrusion policies.
 
    
 
   
 
    
     [bookmark: pgfId-1599895][bookmark: 44402]Understanding How Policies Examine Traffic For Intrusions
 
    [bookmark: pgfId-1599902]License: Protection
 
    [bookmark: pgfId-1567562]When the system analyzes traffic as part of your access control deployment, the network analysis (decoding and preprocessing) phase occurs before and separately from the intrusion prevention (intrusion rules and advanced settings) phase.
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1632585]In an inline deployment, the system can block traffic without further inspection at almost any step in the illustrated process. Security Intelligence, the SSL policy, network analysis policies, file policies, and intrusion policies can all either drop or modify traffic. Only the network discovery policy, which passively inspects packets, cannot affect the flow of traffic.
 
    [bookmark: pgfId-1632542]Similarly, at each step of the process, a packet could cause the system to generate an event. Intrusion and preprocessor events (sometimes referred to collectively as intrusion events) are indications that a packet or its contents may represent a security risk.
 
     
      
    
 
    
 
    [bookmark: pgfId-1632655]Tip The diagram does not reflect that access control rules handle encrypted traffic when your SSL inspection configuration allows it to pass, or if you do not configure SSL inspection. By default, the system disables intrusion and file inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion and file inspection configured. For more information, see Understanding Traffic Decryption and Using the SSL Preprocessor.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1632953]Note that for a single connection, although the system selects a network analysis policy before an access control rule as shown in the diagram, some preprocessing (notably application layer preprocessing) occurs after access control rule selection. This does not affect how you configure preprocessing in custom network analysis policies.
 
    [bookmark: pgfId-1628926]For more information, see:
 
     
     	 [bookmark: pgfId-1601962]Decoding, Normalizing, and Preprocessing: Network Analysis Policies
 
     	 [bookmark: pgfId-1601998]Access Control Rules: Intrusion Policy Selection
 
     	 [bookmark: pgfId-1602004]Intrusion Inspection: Intrusion Policies, Rules, and Variable Sets
 
     	 [bookmark: pgfId-1602010]Intrusion Event Generation
 
    
 
     
      [bookmark: pgfId-1555674][bookmark: 62449]Decoding, Normalizing, and Pr[bookmark: marker-1586731]epr[bookmark: marker-1586732][bookmark: marker-1586733]oc[bookmark: marker-1586734]essing: Network Analysis Policies
 
     [bookmark: pgfId-1629691]License: Protection
 
     [bookmark: pgfId-1629692]Without decoding and preprocessing, the system could not appropriately evaluate traffic for intrusions because protocol differences would make pattern matching impossible. As shown in the diagram in Understanding How Policies Examine Traffic For Intrusions, network analysis policies govern these traffic-handling tasks:
 
      
      	 [bookmark: pgfId-1631042] after traffic is filtered by Security Intelligence
 
      	 [bookmark: pgfId-1631043] after encrypted traffic is decrypted by an optional SSL policy
 
      	 [bookmark: pgfId-1631044] before traffic can be inspected by file or intrusion policies
 
     
 
     [bookmark: pgfId-1629645]A network analysis policy governs packet processing in phases. First the system decodes packets through the first three TCP/IP layers, then continues with normalizing, preprocessing, and detecting protocol anomalies: 
 
      
      	 [bookmark: pgfId-1583886]The packet decoder converts packet headers and payloads into a format that can be easily used by the preprocessors and later, intrusion rules. Each layer of the TCP/IP stack is decoded in turn, beginning with the data link layer and continuing through the network and transport layers. The packet decoder also detects various anomalous behaviors in packet headers. For more information, see Understanding Packet Decoding.
 
      	 [bookmark: pgfId-1584328]In inline deployments, the inline normalization preprocessor reformats (normalizes) traffic to minimize the chances of attackers evading detection. It prepares packets for examination by other preprocessors and intrusion rules, and helps ensure that the packets the system processes are the same as the packets received by the hosts on your network. For more information, see Normalizing Inline Traffic.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1584626]Tip In a passive deployment, Cisco recommends that you configure adaptive profiles at the access control policy level, instead of inline normalization at the network analysis level. For more information, see Tuning Preprocessing in Passive Deployments.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1583890]Various network and transport layers preprocessors detect attacks that exploit IP fragmentation, perform checksum validation, and perform TCP and UDP session preprocessing; see Configuring Transport & Network Layer Preprocessing.
 
     
 
     [bookmark: pgfId-1585739]Note that some advanced transport and network preprocessor settings apply globally to all traffic handled by the target devices of an access control policy. You configure these in the access control policy rather than in a network analysis policy; see Configuring Advanced Transport/Network Settings.
 
      
      	 [bookmark: pgfId-1583894]Various application-layer protocol decoders normalize specific types of packet data into formats that the intrusion rules engine can analyze. Normalizing application-layer protocol encodings allows the system to effectively apply the same content-related intrusion rules to packets whose data is represented differently, and to obtain meaningful results. For more information, see Using Application Layer Preprocessors.
 
      	 [bookmark: pgfId-1583898]The Modbus and DNP3 SCADA preprocessors detect traffic anomalies and provide data to intrusion rules. Supervisory Control and Data Acquisition (SCADA) protocols monitor, control, and acquire data from industrial, infrastructure, and facility processes such as manufacturing, production, water treatment, electric power distribution, airport and shipping systems, and so on. For more information, see Configuring SCADA Preprocessing.
 
      	 [bookmark: pgfId-1586011]Several preprocessors allow you to detect specific threats, such as Back Orifice, portscans, SYN floods and other rate-based attacks; see Detecting Specific Threats.
 
     
 
     [bookmark: pgfId-1616549]Note that you configure the sensitive data preprocessor, which detects sensitive data such as credit card numbers and Social Security numbers in ASCII text, in intrusion policies; see Detecting Sensitive Data.
 
     [bookmark: pgfId-1616553]In a newly created access control policy, one default network analysis policy governs preprocessing for all traffic for all intrusion policies invoked by the same parent access control policy. Initially, the system uses the Balanced Security and Connectivity network analysis policy as the default, but you can change it to another system-provided or custom network analysis policy. In a more complex deployment, advanced users can tailor traffic preprocessing options to specific security zones, networks, and VLANs by assigning different custom network analysis policies to preprocess matching traffic. For more information, see Comparing System-Provided with Custom Policies.
 
    
 
     
      [bookmark: pgfId-1583640][bookmark: 11949]Access Control Rules: Intrusion Policy Selection
 
     [bookmark: pgfId-1606949]License: Protection
 
     [bookmark: pgfId-1555785]After initial preprocessing, access control rules (when present) evaluate traffic. In most cases, the first access control rule that a packet matches is the rule that handles that traffic; you can monitor, trust, block, or allow matching traffic.
 
     [bookmark: pgfId-1631143]When you allow traffic with an access control rule, the system can inspect the traffic for discovery data, malware, prohibited files, and intrusions, in that order. Traffic not matching any access control rule is handled by the access control policy’s default action, which can also inspect for discovery data and intrusions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1586197]Note All packets, regardless of which network analysis policy preprocesses them, are matched to configured access control rules—and thus are potentially subject to inspection by intrusion policies—in top-down order. For more information, see Limitations of Custom Policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1614454]The diagram in Understanding How Policies Examine Traffic For Intrusions shows the flow of traffic through a device in an inline, intrusion prevention and AMP deployment, as follows:
 
      
      	 [bookmark: pgfId-1555787]Access Control Rule A allows matching traffic to proceed. The traffic is then inspected for discovery data by the network discovery policy, for prohibited files and malware by File Policy A, and then for intrusions by Intrusion Policy A.
 
      	 [bookmark: pgfId-1557410]Access Control Rule B also allows matching traffic. However, in this scenario, the traffic is not inspected for intrusions (or files or malware), so there are no intrusion or file policies associated with the rule. Note that by default, traffic that you allow to proceed is inspected by the network discovery policy; you do not need to configure this.
 
      	 [bookmark: pgfId-1616804]In this scenario, the access control policy’s default action allows matching traffic. The traffic is then inspected by the network discovery policy, and then by an intrusion policy. You can (but do not have to) use a different intrusion policy when you associate intrusion policies with access control rules or the default action.
 
     
 
     [bookmark: pgfId-1616805]The example in the diagram does not include any blocking or trusting rules because the system does not inspect blocked or trusted traffic. For more information, see Using Rule Actions to Determine Traffic Handling and Inspection and Setting Default Handling and Inspection for Network Traffic.
 
    
 
     
      [bookmark: pgfId-1565548][bookmark: 19654]Intrusion Inspec[bookmark: marker-1605875][bookmark: marker-1605876]tion: Intrusion Policies, Rules, and Variable Sets
 
     [bookmark: pgfId-1606980]License: Protection
 
     [bookmark: pgfId-1588423]You can use intrusion prevention as the system’s last line of defense before traffic is allowed to proceed to its destination. Intrusion policies govern how the system inspects traffic for security violations and, in inline deployments, can block or alter malicious traffic. The main function of intrusion policies is to manage which intrusion and preprocessor rules are enabled and how they are configured.
 
     [bookmark: pgfId-1602429]Intrusion and Preprocessor Rules
 
     [bookmark: pgfId-1601265]An intrusion rule is a specified set of keywords and arguments that detects attempts to exploit vulnerabilities on your network; the system uses an intrusion rule to analyze network traffic to check if it matches the criteria in the rule. The system compares packets against the conditions specified in each rule and, if the packet data matches all the conditions specified in a rule, the rule triggers. 
 
     [bookmark: pgfId-1601294]The system includes the following types of rules created by the VRT: 
 
      
      	 [bookmark: pgfId-1601302] shared object intrusion rules , which are compiled and cannot be modified (except for rule header information such as source and destination ports and IP addresses)
 
      	 [bookmark: pgfId-1601304] standard text intrusion rules , which can be saved and modified as new custom instances of the rule.
 
      	 [bookmark: pgfId-1601255] preprocessor rules , which are rules associated with preprocessors and packet decoder detection options in the network analysis policy. You cannot copy or edit preprocessor rules. Most preprocessor rules are disabled by default; you must enable them to use preprocessors to generate events and, in an inline deployment, drop offending packets.
 
     
 
     [bookmark: pgfId-1601429]When the system processes packets according to an intrusion policy, first a rule optimizer classifies all activated rules in subsets based on criteria such as: transport layer, application protocol, direction to or from the protected network, and so on. Then, the intrusion rules engine selects the appropriate rule subsets to apply to each packet. Finally, a multi-rule search engine performs three different types of searches to determine if the traffic matches the rule:
 
      
      	 [bookmark: pgfId-1601430]The protocol field search looks for matches in particular fields in an application protocol.
 
      	 [bookmark: pgfId-1601431]The generic content search looks for ASCII or binary byte matches in the packet payload.
 
      	 [bookmark: pgfId-1601432]The packet anomaly search looks for packet headers and payloads that, rather than containing specific content, violate well-established protocols.
 
     
 
     [bookmark: pgfId-1602175]In a custom intrusion policy, you can tune detection by enabling and disabling rules, as well as by writing and adding your own standard text rules. You can also use FireSIGHT recommendations to associate the operating systems, servers, and client application protocols detected on your network with rules specifically written to protect those assets.
 
     [bookmark: pgfId-1602219]Variable Sets
 
     [bookmark: pgfId-1601467]Whenever the system uses an intrusion policy to evaluate traffic, it uses an associated variable set. Most variables in a set represent values commonly used in intrusion rules to identify source and destination IP addresses and ports. You can also use variables in intrusion policies to represent IP addresses in rule suppressions and dynamic rule states.
 
     [bookmark: pgfId-1601719]The system provides a single default variable set, which is comprised of predefined default variables. Most system-provided shared object rules and standard text rules use these predefined default variables to define networks and port numbers. For example, the majority of the rules use the variable $HOME_NET to specify the protected network and the variable $EXTERNAL_NET to specify the unprotected (or outside) network. In addition, specialized rules often use other predefined variables. For example, rules that detect exploits against web servers use the $HTTP_SERVERS and $HTTP_PORTS variables.
 
      
       
     
 
     
 
     [bookmark: pgfId-1604649]Tip Even if you use system-provided intrusion policies, Cisco strongly recommends you modify key default variables in the default set. When you use variables that accurately reflect your network environment, processing is optimized and the system can monitor relevant systems for suspicious activity. Advanced users can create and use custom variable sets for pairing with one or more custom intrusion policies. For more information, see Optimizing Predefined Default Variables.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1607002][bookmark: 26686]Intrusion Event Gener[bookmark: marker-1607001]ation
 
     [bookmark: pgfId-1607031]License: Protection
 
     [bookmark: pgfId-1607003]When the system identifies a possible intrusion, it generates an intrusion or preprocessor event (sometimes collectively called intrusion events). Managed devices transmit their events to the Defense Center, where you can view the aggregated data and gain a greater understanding of the attacks against your network assets. In an inline deployment, managed devices can also drop or replace packets that you know to be harmful.
 
     [bookmark: pgfId-1604070]Each intrusion event in the database includes an event header and contains information about the event name and classification; the source and destination IP addresses; ports; the process that generated the event; and the date and time of the event, as well as contextual information about the source of the attack and its target. For packet-based events, the system also logs a copy of the decoded packet header and payload for the packet or packets that triggered the event. 
 
     [bookmark: pgfId-1588237]The packet decoder, the preprocessors, and the intrusion rules engine can all cause the system to generate an event. For example:
 
      
      	 [bookmark: pgfId-1603080]If the packet decoder (configured in the network analysis policy) receives an IP packet that is less than 20 bytes, which is the size of an IP datagram without any options or payload, the decoder interprets this as anomalous traffic. If, later, the accompanying decoder rule in the intrusion policy that examines the packet is enabled, the system generates a preprocessor event. 
 
      	 [bookmark: pgfId-1603122]If the IP defragmentation preprocessor encounters a series of overlapping IP fragments, the preprocessor interprets this as a possible attack and, when the accompanying preprocessor rule is enabled, the system generates a preprocessor event. 
 
      	 [bookmark: pgfId-1603143]Within the intrusion rules engine, most standard text rules and shared object rules are written so that they generate intrusion events when triggered by packets.
 
     
 
     [bookmark: pgfId-1605898]As the database accumulates intrusion events, you can begin your analysis of potential attacks. The system provides you with the tools you need to review intrusion events and evaluate whether they are important in the context of your network environment and your security policies.
 
    
 
   
 
    
     [bookmark: pgfId-1587538][bookmark: 37349]Comparing System-Provided with Custom Policies
 
    [bookmark: pgfId-1607110]License: Protection
 
    [bookmark: pgfId-1567858]Creating a new access control policy is one of the first steps in managing traffic flow using the FireSIGHT System. By default, a newly created access control policy invokes system-provided network analysis and intrusion policies to examine traffic.
 
    [bookmark: pgfId-1627402]The following diagram shows how a newly created access control policy in an inline, intrusion-prevention deployment initially handles traffic. The preprocessing and intrusion prevention phases are highlighted.
 
    [bookmark: pgfId-1641618]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1576356]Note how:
 
     
     	 [bookmark: pgfId-1561654]A default network analysis policy governs the preprocessing of  all traffic handled by the access control policy. Initially, the system-provided  Balanced Security and Connectivity network analysis policy is the default.
 
     	 [bookmark: pgfId-1561616]The default action of the access control policy allows all non-malicious traffic, as determined by the system-provided  Balanced Security and Connectivity intrusion policy . Because the default action allows traffic to pass, the discovery feature can examine it for host, application, and user data before the intrusion policy can examine and potentially block malicious traffic.
 
     	 [bookmark: pgfId-1577220]The policy uses default Security Intelligence options (global whitelist and blacklist only), does not decrypt encrypted traffic with an SSL policy, and does not perform special handling and inspection of network traffic using access control rules.
 
    
 
    [bookmark: pgfId-1562480]A simple step you can take to tune your intrusion prevention deployment is to use a different set of system-provided network analysis and intrusion policies as your defaults. Cisco delivers several pairs of these policies with the FireSIGHT System.
 
    [bookmark: pgfId-1577258]Or, you can tailor your intrusion prevention deployment by creating and using custom policies. You may find that the preprocessor options, intrusion rule, and other advanced settings configured in those policies do not address the security needs of your network. By tuning your network analysis and intrusion policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions. 
 
    [bookmark: pgfId-1577291]For more information, see:
 
     
     	 [bookmark: pgfId-1570234]Understanding the System-Provided Policies
 
     	 [bookmark: pgfId-1576190]Benefits of Custom Policies
 
     	 [bookmark: pgfId-1576231]Limitations of Custom Policies
 
    
 
     
      [bookmark: pgfId-1568005][bookmark: 34357]Understanding the System-Provided Policies
 
     [bookmark: pgfId-1607141]License: Protection
 
     [bookmark: pgfId-1591878]Cisco delivers several pairs of network analysis and intrusion policies with the FireSIGHT System. By using system-provided network analysis and intrusion policies, you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states, as well as provides the initial configurations for preprocessors and other advanced settings.
 
     [bookmark: pgfId-1642916]No system-provided policy covers every network profile, traffic mix, or defensive posture. Each covers common cases and network setups that provide a starting point for a well-tuned defensive policy. Although you can use system-provided policies as-is, Cisco strongly recommends that you use them as the base for custom policies that you tune to suit your network.
 
      
       
     
 
     
 
     [bookmark: pgfId-1593276]Tip Even if you use system-provided network analysis and intrusion policies, you should configure the system’s intrusion variables to accurately reflect your network environment. At a minimum, modify key default variables in the default set; see Optimizing Predefined Default Variables.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1592160]As new vulnerabilities become known, the VRT releases intrusion rule updates. These rule updates can modify any system-provided network analysis or intrusion policy, and can provide new and updated intrusion rules and preprocessor rules, modified states for existing rules, and modified default policy settings. Rule updates may also delete rules from system-provided policies and provide new rule categories, as well as modify the default variable set. 
 
     [bookmark: pgfId-1618277]If a rule update affects your deployment, the web interface marks affected intrusion and network analysis policies as out of date, as well as their parent access control policies. You must reapply an updated policy for its changes to take effect. 
 
     [bookmark: pgfId-1631251]For your convenience, you can configure rule updates to automatically reapply affected intrusion policies, either alone or in combination with affected access control policies. This allows you to easily and automatically keep your deployment up-to-date to protect against recently discovered exploits and intrusions.
 
     [bookmark: pgfId-1633098]To ensure up-to-date preprocessing settings, you must reapply access control policies, which also reapplies any associated SSL, network analysis, and file policies that are different from those currently running, and can also can update default values for advanced preprocessing and performance options. For more information, see Importing Rule Updates and Local Rule Files.
 
     [bookmark: pgfId-1576458]Cisco delivers the following network analysis and intrusion policies with the FireSIGHT System:
 
     [bookmark: pgfId-1559890][bookmark: marker-1559889]Balanced Security and Connectivity network analysis and intrusion policies
 
     [bookmark: pgfId-1559891]These policies are built for both speed and detection. Used together, they serve as a good starting point for most organizations and deployment types. The system uses the Balanced Security and Connectivity policies and settings as defaults in most cases.
 
     [bookmark: pgfId-1559893][bookmark: marker-1559892]Connectivity Over Security network analysis and intrusion policies
 
     [bookmark: pgfId-1559894]These policies are built for organizations where connectivity (being able to get to all resources) takes precedence over network infrastructure security. The intrusion policy enables far fewer rules than those enabled in the Security over Connectivity policy. Only the most critical rules that block traffic are enabled.
 
     [bookmark: pgfId-1559896][bookmark: marker-1559895]Security Over Connectivity network analysis and intrusion policies
 
     [bookmark: pgfId-1559897]These policies are built for organizations where network infrastructure security takes precedence over user convenience. The intrusion policy enables numerous network anomaly intrusion rules that could alert on or drop legitimate traffic.
 
     [bookmark: pgfId-1642793][bookmark: marker-1643071]Maximum Detection network analysis and intrusion policies
 
     [bookmark: pgfId-1642795]These policies are built for organizations where network infrastructure security is given even more emphasis than is given by the Security Over Connectivity policies, with the potential for even greater operational impact. For example, the intrusion policy enables rules in a large number of threat categories including malware, exploit kit, old and common vulnerabilities, and known in-the-wild exploits.
 
     [bookmark: pgfId-1559898]No Rules Active intrusion policy
 
     [bookmark: pgfId-1559899]In the No Rules Active intrusion policy, all intrusion rules and advanced settings are disabled. This policy provides a starting point if you want to create your own intrusion policy instead of basing it on the enabled rules in one of the other system-provided policies.
 
    
 
     
      [bookmark: pgfId-1555817][bookmark: 79777]Benefits of Custom Polic[bookmark: marker-1605858]ies
 
     [bookmark: pgfId-1607164]License: Protection
 
     [bookmark: pgfId-1591794]You may find that the preprocessor options, intrusion rules, and other advanced settings configured in the system-provided network analysis and intrusion policies do not fully address the security needs of your organization.
 
     [bookmark: pgfId-1594071]Building custom policies can improve the performance of the system in your environment and can provide a focused view of the malicious traffic and policy violations occurring on your network. By creating and tuning custom policies you can configure, at a very granular level, how the system processes and inspects the traffic on your network for intrusions.
 
     [bookmark: pgfId-1594251]All custom policies have a base policy, also called a base layer, which defines the default settings for all configurations in the policy. A layer is a building block that you can use to efficiently manage multiple network analysis or intrusion policies; see Using Layers in a Network Analysis or Intrusion Policy.
 
     [bookmark: pgfId-1595087]In most cases, you base custom policies on system-provided policies, but you can use another custom policy. However, all custom policies have a system-provided policy as the eventual base in a policy chain. Because rule updates can modify system-provided policies, importing a rule update may affect you even if you are using a custom policy as your base. If a rule update affects your deployment, the web interface marks affected policies as out of date. For more information, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
     [bookmark: pgfId-1590971]In addition to custom policies that you create, the system provides two custom intrusion and two custom network analysis policies: Initial Inline Policy and Initial Passive Policy. These policies use the appropriate Balanced Security and Connectivity policy as their base. The only difference between them is their drop behavior, which enables traffic blocking and modification in the inline policies and disables it in the passive policies. You can edit and use these system-provided custom policies.
 
     [bookmark: pgfId-1605644]For more information, see:
 
      
      	 [bookmark: pgfId-1605691]Benefits of a Custom Network Analysis Policy
 
      	 [bookmark: pgfId-1605712]Benefits of Custom Intrusion Policies
 
     
 
    
 
     
      [bookmark: pgfId-1577637][bookmark: 85883]Benefits of a Custom Network Analysis Policy
 
     [bookmark: pgfId-1605753]License: Protection
 
     [bookmark: pgfId-1595543]By default, one network analysis policy preprocesses all unencrypted traffic handled by the access control policy. That means that all packets are decoded and preprocessed according to the same settings, regardless of the intrusion policy (and therefore intrusion rule set) that later examines them. 
 
     [bookmark: pgfId-1606799]Initially, the system-provided Balanced Security and Connectivity network analysis policy is the default. A simple way to tune preprocessing is to create and use a custom network analysis policy as the default; see Setting the Default Network Analysis Policy for Access Control. 
 
     [bookmark: pgfId-1606789]Tuning options available vary by preprocessor, but some of the ways you can tune preprocessors and decoders include: 
 
      
      	 [bookmark: pgfId-1595693]You can disable preprocessors that do not apply to the traffic you are monitoring. For example, the HTTP Inspect preprocessor normalizes HTTP traffic. If you are confident that your network does not include any web servers using Microsoft Internet Information Services (IIS), you can disable the preprocessor option that looks for IIS-specific traffic and thereby reduce system processing overhead.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1607951]Note If you disable a preprocessor in a custom network analysis policy, but the system needs to use that preprocessor to later evaluate packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although the preprocessor remains disabled in the network analysis policy web interface.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-1607952]Specify ports, where appropriate, to focus the activity of certain preprocessors. For example, you can identify additional ports to monitor for DNS server responses or encrypted SSL sessions, or ports on which you decode telnet, HTTP, and RPC traffic.
 
     
 
     [bookmark: pgfId-1596955]For advanced users with complex deployments, you can create multiple network analysis policies, each tailored to preprocess traffic differently. Then, you can configure the system to use those policies to govern the preprocessing of traffic using different security zones, networks, or VLANs. (Note that ASA FirePOWER devices cannot restrict preprocessing by VLAN.) 
 
      
       
     
 
     
 
     [bookmark: pgfId-1597697]Note Tailoring preprocessing using custom network analysis policies—especially multiple network analysis policies—is an advanced task. Because preprocessing and intrusion inspection are so closely related, you must be careful to allow the network analysis and intrusion policies examining a single packet to complement each other. For more information, see Limitations of Custom Policies.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1606892][bookmark: 56388]Benefits of Custom Intrusion Policies
 
     [bookmark: pgfId-1606899]License: Protection
 
     [bookmark: pgfId-1606900]In a newly created access control policy initially configured to perform intrusion prevention, the default action allows all traffic, but first inspects it with the system-provided Balanced Security and Connectivity intrusion policy. Unless you add access control rules or change the default action, all traffic is inspected by that intrusion policy; see the diagram in Comparing System-Provided with Custom Policies.
 
     [bookmark: pgfId-1599814]To customize your intrusion prevention deployment, you can create multiple intrusion policies, each tailored to inspect traffic differently. Then, configure an access control policy with rules that specify which policy inspects which traffic. Access control rules can be simple or complex, matching and inspecting traffic using multiple criteria including security zone, network or geographical location, VLAN, port, application, requested URL, or user. The scenario in Understanding How Policies Examine Traffic For Intrusions shows a deployment where traffic is inspected by one of two intrusion policies.
 
     [bookmark: pgfId-1598599]The main function of intrusion policies is to manage which intrusion and preprocessor ru[bookmark: marker-1600250]les are enabled and how they are configured, as follows:
 
      
      	 [bookmark: pgfId-1577324]Within each intrusion policy, you should verify that all rules applicable to your environment are enabled, and improve performance by disabling rules that are not applicable to your environment. In an inline deployment, you can specify which rules should drop or modify malicious packets. For more information, see Setting Rule States.
 
      	 [bookmark: pgfId-1598485]FireSIGHT recommendations allow you to associate the operating systems, servers, and client application protocols detected on your network with rules specifically written to protect those assets; see Tailoring Intrusion Protection to Your Network Assets.
 
      	 [bookmark: pgfId-1600346]You can modify existing rules and write new standard text rules as needed to catch new exploits or to enforce your security policies; see Understanding and Writing Intrusion Rules.
 
     
 
     [bookmark: pgfId-1600266]Other customizations you might make to an intrusion policy include:
 
      
      	 [bookmark: pgfId-1605223]The sensitive data preprocessor detects sensitive data such as credit card numbers and Social Security numbers in ASCII text. Note that other preprocessors that detect specific threats (back orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic) are configured in network analysis policies. For more information, see Detecting Specific Threats.
 
      	 [bookmark: pgfId-1605227]Global thresholds cause the system to generate events based on how many times traffic matching an intrusion rule originates from or is targeted to a specific address or address range within a specified time period. This helps prevent the system from being overwhelmed with a large number of events. For more information, see Globally Limiting Intrusion Event Logging.
 
      	 [bookmark: pgfId-1605436]Suppressing intrusion event notifications and setting thresholds for individual rules or entire intrusion policies can also can prevent the system from being overwhelmed with a large number of events. For more information, see Filtering Intrusion Event Notification Per Policy.
 
      	 [bookmark: pgfId-1605231]In addition to the various views of intrusion events within the web interface, you can enable logging to syslog facilities or send event data to an SNMP trap server. Per policy, you can specify intrusion event notification limits, set up intrusion event notification to external logging facilities, and configure external responses to intrusion events. Note that in addition to these per-policy alerting configurations, you can globally enable or disable email alerting on intrusion events for each rule or rule group. Your email alert settings are used regardless of which intrusion policy processes a packet. For more information, see Configuring External Alerting for Intrusion Rules.
 
     
 
    
 
     
      [bookmark: pgfId-1595978][bookmark: 77890]Limitations of Custom Policies
 
     [bookmark: pgfId-1607231]License: Protection
 
     [bookmark: pgfId-1572617]Because preprocessing and intrusion inspection are so closely related, you must be careful that your configuration allows the network analysis and intrusion policies processing and examining a single packet to complement each other. 
 
     [bookmark: pgfId-1605942]By default, the system uses one network analysis policy to preprocess all traffic handled by managed devices using a single access control policy. The following diagram shows how a newly created access control policy in an inline, intrusion-prevention deployment initially handles traffic. The preprocessing and intrusion prevention phases are highlighted.
 
     [bookmark: pgfId-1641642]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1605981]Notice how a default network analysis policy governs the preprocessing of all traffic handled by the access control policy. Initially, the system-provided Balanced Security and Connectivity network analysis policy is the default.
 
     [bookmark: pgfId-1619017]A simple way to tune preprocessing is to create and use a custom network analysis policy as the default, as summarized in Benefits of a Custom Network Analysis Policy. However, if you disable a preprocessor in a custom network analysis policy but the system needs to evaluate preprocessed packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although it remains disabled in the network analysis policy web interface. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1619021]Note In order to get the performance benefits of disabling a preprocessor, you must make sure that none of your intrusion policies have enabled rules that require that preprocessor.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1605963]An additional challenge arises if you use multiple custom network analysis policies. For advanced users with complex deployments, you can tailor preprocessing to specific security zones, networks, and VLANs by assigning custom network analysis policies to preprocess matching traffic. (Note that ASA FirePOWER devices cannot restrict preprocessing by VLAN.) To accomplish this, you add custom network analysis rules to your access control policy. Each rule has an associated network analysis policy that governs the preprocessing of traffic that matches the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-1608368]Tip You configure network analysis rules as an advanced setting in an access control policy. Unlike other types of rules in the FireSIGHT System, network analysis rules invoke—rather than being contained by—network analysis policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1607865]The system matches packets to any configured network analysis rules in top-down order by rule number. Traffic that does not match any network analysis rule is preprocessed by the default network analysis policy. While this allows you a great deal of flexibility in preprocessing traffic, keep in mind that all packets, regardless of which network analysis policy preprocessed them, are subsequently matched to access control rules—and thus to potential inspection by intrusion policies—in their own process. In other words, preprocessing a packet with a particular network analysis policy does not guarantee that the packet will be examined with any particular intrusion policy. You must carefully configure your access control policy so it invokes the correct network analysis and intrusion policies to evaluate a particular packet.
 
     [bookmark: pgfId-1608880]The following diagram shows in focused detail how the network analysis policy (preprocessing) selection phase occurs before and separately from the intrusion prevention (rules) phase. For simplicity, the diagram eliminates the discovery and file/malware inspection phases. It also highlights the default network analysis and default-action intrusion policies.
 
     [bookmark: pgfId-1641666]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1608756]In this scenario, an access control policy is configured with two network analysis rules and a default network analysis policy:
 
      
      	 [bookmark: pgfId-1557267]Network Analysis Rule A preprocesses matching traffic with Network Analysis Policy A. Later, you want this traffic to be inspected by Intrusion Policy A.
 
      	 [bookmark: pgfId-1608750]Network Analysis Rule B preprocesses matching traffic with Network Analysis Policy B. Later, you want this traffic to be inspected by Intrusion Policy B.
 
      	 [bookmark: pgfId-1608751]All remaining traffic is preprocessed with the default network analysis policy. Later, you want this traffic to be inspected by the intrusion policy associated with the access control policy’s default action.
 
     
 
     [bookmark: pgfId-1608752]After the system preprocesses traffic, it can examine the traffic for intrusions. The diagram shows an access control policy with two access control rules and a default action:
 
      
      	 [bookmark: pgfId-1558015]Access Control Rule A allows matching traffic. The traffic is then inspected by Intrusion Policy A.
 
      	 [bookmark: pgfId-1558016]Access Control Rule B allows matching traffic. The traffic is then inspected by Intrusion Policy B.
 
      	 [bookmark: pgfId-1609042]The access control policy’s default action allows matching traffic. The traffic is then inspected by the default action’s intrusion policy.
 
     
 
     [bookmark: pgfId-1631786]Each packet’s handling is governed by a network analysis policy and intrusion policy pair, but the system does not coordinate the pair for you. Consider a scenario where you misconfigure your access control policy so that Network Analysis Rule A and Access Control Rule A do not process the same traffic. For example, you could intend the paired policies to govern the handling of traffic on a particular security zone, but you mistakenly use different zones in the two rules’ conditions. This could cause traffic to be incorrectly preprocessed. For this reason, tailoring preprocessing using network analysis rules and custom policies is an advanced task. 
 
     [bookmark: pgfId-1631798]Note that for a single connection, although the system selects a network analysis policy before an access control rule, some preprocessing (notably application layer preprocessing) occurs after access control rule selection. This does not affect how you configure preprocessing in custom network analysis policies.
 
    
 
   
 
    
     [bookmark: pgfId-1611216][bookmark: 99072]Using the Nav[bookmark: marker-1611215]igation Panel
 
    [bookmark: pgfId-1611223]License: Protection
 
    [bookmark: pgfId-1538044]Network analysis and intrusion policies use similar web interfaces to edit and save changes to their configurations; see:
 
     
     	 [bookmark: pgfId-1538048]Editing Network Analysis Policies
 
     	 [bookmark: pgfId-1538052]Editing Intrusion Policies
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1540085]A dividing line separates the navigation panel into links to policy settings you can configure with (below) or without (above) direct interaction with policy layers. To navigate to any settings page, click its name in the navigation panel. Dark shading of an item in the navigation panel highlights your current settings page. For example, in the illustration above the Policy Information page would be displayed to the right of the navigation panel.
 
    [bookmark: pgfId-1540194]Policy Information
 in the navigation panel when the policy contains unsaved changes. The icon disappears when you save your changes. 
    
 
    [bookmark: pgfId-1540251]Rules (intrusion policy only)
 
    [bookmark: pgfId-1540862]The Rules page in an intrusion policy allows you to configure rule states and other settings for shared object rules, standard text rules, and preprocessor rules. For more information, see Tuning Intrusion Policies Using Rules.
 
    [bookmark: pgfId-1540300]FireSIGHT Recommendations (intrusion policy only)
 
    [bookmark: pgfId-1540918]The FireSIGHT Recommendations page in an intrusion policy allows you to associate the operating systems, servers, and client application protocols detected on your network with intrusion rules specifically written to protect those assets. This allows you to tailor your intrusion policy to the specific needs of your monitored network. For more information, see Tailoring Intrusion Protection to Your Network Assets.
 
    [bookmark: pgfId-1540633]Settings (network analysis policy) and Advanced Settings (intrusion policy)
 
    [bookmark: pgfId-1541370]The Settings page in a network analysis policy allows you to enable or disable preprocessors and access preprocessor configuration pages. Expanding the Settings link displays sublinks to individual configuration pages for all enabled preprocessors in the policy. For more information, see Configuring Preprocessors in a Network Analysis Policy.
 
    [bookmark: pgfId-1541366]The Advanced Settings page in an intrusion policy allows you to enable or disable advanced settings and access configuration pages for those advanced settings. Expanding the Advanced Settings link displays sublinks to individual configuration pages for all enabled advanced settings in the policy. For more information, see Configuring Advanced Settings in an Intrusion Policy.
 
    [bookmark: pgfId-1540227]Policy Layers
 
    [bookmark: pgfId-1541740]The Policy Layers page displays a summary of the layers that comprise your network analysis or intrusion policy. Expanding the Policy Layers link displays sublinks to summary pages for the layers in your policy. Expanding each layer sublink displays further sublinks to the configuration pages for all rules, preprocessors, or advanced settings that are enabled in the layer. For more information, see Using Layers in a Network Analysis or Intrusion Policy.
 
   
 
    
     [bookmark: pgfId-1541764][bookmark: 31630]Resolving Conflicts and Committing Policy Ch[bookmark: marker-1541762][bookmark: marker-1541763]anges
 
    [bookmark: pgfId-1534705]License: Protection
 ) your changes before the system recognizes them. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1623474]Note After you save, you must apply a network analysis or intrusion policy for your changes to take effect. If you apply a policy without saving, the system uses the most recently saved configuration. Although you can reapply an intrusion policy independently, network analysis policies are applied with their parent access control policy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1625353]Resolving Editing Conflicts
 
    [bookmark: pgfId-1625891]The Network Analysis Policy page (Policies > Access Control, then click Network Analysis Policy) and Intrusion Policy page (Policies > Intrusion Policy > Intrusion Policy) display whether each policy has unsaved changes, as well as information about who is currently editing the policy. Cisco recommends that only one person edit a policy at a time. If you are performing simultaneous editing, the consequences are as follows:
 
     
     	 [bookmark: pgfId-1625379]If you are editing a network analysis or intrusion policy at the same time another user is editing the same policy, and the other user saves their changes to the policy, you are warned when you commit the policy that you will overwrite the other user’s changes.
 
     	 [bookmark: pgfId-1625380]If you are editing the same network analysis or intrusion policy via multiple web interface instances as the same user, and you save your changes for one instance, you cannot save your changes for the other instance.
 
    
 
    [bookmark: pgfId-1625616]Resolving Configuration Dependencies
 
    [bookmark: pgfId-1625617]To perform their particular analysis, many preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way, or have other dependencies. When you save a network analysis or intrusion policy, the system either automatically enables required settings, or warns you that disabled settings will have no effect on traffic, as follows:
 
     
     	 [bookmark: pgfId-1625618]You cannot save an intrusion policy if you added an SNMP rule alert but did not configure SNMP alerting. You must either configure SNMP alerting or disable the rule alert, then save again.
 
     	 [bookmark: pgfId-1625619]You cannot save an intrusion policy if it includes enabled sensitive data rules but you have not enabled the sensitive data preprocessor. You must either allow the system to enable the preprocessor and save the policy, or disable the rules and save again.
 
     	 [bookmark: pgfId-1625620]If you disable a required preprocessor in a network analysis policy, you can still save the policy. However, the system automatically uses the disabled preprocessor with its current settings, even though the preprocessor remains disabled in the web interface. For more information, see Limitations of Custom Policies.
 
     	 [bookmark: pgfId-1625624]If you disable inline mode in a network analysis policy but enable the Inline Normalization preprocessor, you can still save the policy. However, the system warns you that normalization settings will be ignored. Disabling inline mode also causes the system to ignore other settings that allow preprocessors to modify or block traffic, including checksum verification and rate-based attack prevention. For more information, see Allowing Preprocessors to Affect Traffic in Inline Deployments and Normalizing Inline Traffic. 
 
    
 
    [bookmark: pgfId-1625283]Committing, Discarding, and Caching Policy Changes
 
    [bookmark: pgfId-1625855]While editing a network analysis or intrusion policy, if you exit the policy editor without saving your changes, the system caches those changes. Your changes are cached even when you log out of the system or experience a system crash. The system cache can store unsaved changes for one network analysis and one intrusion policy per user; you must commit or discard your changes before editing another policy of the same type. The system discards the cached changes when you edit another policy without saving your changes to the first policy, or when you import an intrusion rule update.
 
    [bookmark: pgfId-1625300]You can commit or discard policy changes on the Policy Information page of either the network analysis or intrusion policy editor; see Editing Network Analysis Policies and Editing Intrusion Policies.
 
     
      
       
       [bookmark: pgfId-1623129]Table 23-1 [bookmark: 35642]Committing Changes to a Network Analysis or Intrusion Policy 
 
       
       
        
        	 
          
          [bookmark: pgfId-1623133]To... 
         
  
        	 
          
          [bookmark: pgfId-1623135]On the Policy Information page, you can... 
         
  
       
 
        
        	[bookmark: pgfId-1623137]save changes to the policy
  
        	[bookmark: pgfId-1623139]click Commit Changes.
 [bookmark: pgfId-1625413]Settings in the system policy govern whether you are prompted (or required) to comment on your network analysis or intrusion policy changes when you commit them. The system policy also governs whether changes and comments are recorded in the [bookmark: marker-1625414]audit log. For more information, see Configuring Network Analysis Policy Preferences and Configuring Intrusion Policy Preferences.
  
       
 
        
        	[bookmark: pgfId-1623146]discard all unsaved changes
  
        	[bookmark: pgfId-1623148]click Discard Changes, then click OK to discard your changes and go to the Intrusion Policy page. If you do not want to discard your changes, click Cancel to return to the Policy Information page.
  
       
 
        
        	[bookmark: pgfId-1623150]exit the policy, but cache changes
  
        	[bookmark: pgfId-1623152]select any menu or other path to another page. On exiting, click Leave page when prompted, or click Stay on page to remain in the advanced editor.
  
       
 
       
     
 
    
 
     
      [bookmark: pgfId-1534674]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1533148][bookmark: 18634]Using Layers in a Network Analysis or Intrusion Policy 
      
      
 
     
 
 
    [bookmark: pgfId-1534998]Larger organizations with many managed devices may have many intrusion policies and network analysis policies to support the unique needs of different departments, business units or, in some instances, different companies. Configurations in both policy types are contained in building blocks called layers, which you can use to efficiently manage multiple policies.
 
    [bookmark: pgfId-1535207]Layers in intrusion and network analysis policies work in essentially the same way. You can create and edit either policy type without consciously using layers. You can modify your policy configurations and, if you have not added user layers to your policy, the system automatically includes your changes in a single configurable layer that is initially named My Changes. Optionally, you can also add up to 200 layers where you can configure any combination of settings. You can copy, merge, move, and delete user layers and, most important, share individual user layers with other policies of the same type.
 
    [bookmark: pgfId-1619055]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1619059]Understanding the Layer Stack describes the user-configurable and built-in layers that comprise a basic policy.
 
     	 [bookmark: pgfId-1612433]Managing Layers explains how to use layers in your policies.
 
    
 
   
 
    
     [bookmark: pgfId-1612439][bookmark: 17146]Understanding the Layer Stack
 
    [bookmark: pgfId-1561634]License: Protection
 
    [bookmark: pgfId-1619005]A network analysis or intrusion policy where you do not add layers includes the built-in, read-only base policy layer and a single user-configurable layer that is initially named My Changes. You can copy, merge, move, or delete any user-configurable layer and set any user-configurable layer to be shared by other policies of the same type.
 
    [bookmark: pgfId-1619006]Each policy layer contains complete configurations for either all preprocessors in a network analysis policy or all intrusion rules and advanced settings in an intrusion policy. The lowest, base policy layer includes all the settings from the base policy you selected when you created the policy. A setting in a higher layer takes precedence over the same setting in a lower layer. Features not explicitly set in a layer inherit their settings from the next highest layer where they are explicitly set.
 
    [bookmark: pgfId-1621648]The system flattens the layers, that is, it applies only the cumulative effect of all settings, when it handles network traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-1621701]Tip You can create an intrusion or network analysis policy based solely on the default settings in the base policy and, optionally in the case of an intrusion policy, using FireSIGHT rule state recommendations.
 
     
     
 
    
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1621740]Note the following points when working with multiple layers:
 
     
     	 [bookmark: pgfId-1621821]When the highest layer in your policy is a read-only layer, or a shared layer as described in Sharing Layers Between Policies, the system automatically adds a user-configurable layer as the highest layer in your intrusion policy if you do either of the following:
 
    
 
    [bookmark: pgfId-1561649] – modify a rule action (that is, a rule state, event filtering, dynamic state, or alerting) on the intrusion policy Rules page. See Tuning Intrusion Policies Using Rules for more information.
 
    [bookmark: pgfId-1561653] – enable, disable, or modify any preprocessor, intrusion rule, or advanced setting.
 
    [bookmark: pgfId-1561657]All settings in the system-added layer are inherited except for the changes that resulted in the new layer.
 
     
     	 [bookmark: pgfId-1561658]When the highest layer is a shared layer, the system adds a layer when you take either of the following actions:
 
    
 
    [bookmark: pgfId-1589793] – share the highest layer with other policies
 
    [bookmark: pgfId-1589815] – add a shared layer to your policy
 
     
     	 [bookmark: pgfId-1586880]Regardless of whether you allow rule updates to modify your policy, changes in a rule update never override changes you make in a layer. This is because changes in a rule update are made in the base policy, which determines the default settings in your base policy layer; your changes are always made in a higher layer, so they override any changes that a rule update makes to your base policy. See Importing Rule Updates and Local Rule Files for more information.
 
    
 
    [bookmark: pgfId-1617204]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1617259]Understanding the Base Layer
 
     	 [bookmark: pgfId-1617282]Understanding the FireSIGHT Recommendations Layer
 
    
 
     
      [bookmark: pgfId-1561667][bookmark: 28494]Understan[bookmark: BasePolicy]ding the [bookmark: marker-1561666]Base Layer
 
     [bookmark: pgfId-1561674]License: Protection
 
     [bookmark: pgfId-1586877]The base layer, also referred to as the base policy, of an intrusion or network analysis policy defines the default settings for all configurations in the policy, and is the lowest layer in the policy. When you create a new policy and change a setting without adding new layers, the change is stored in the My Changes layer, and overrides—but does not change—the setting in the base policy.
 
     [bookmark: pgfId-1579531]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1579535]Understanding System-Provided Base Policies
 
      	 [bookmark: pgfId-1622070]Understanding Custom Base Policies
 
      	 [bookmark: pgfId-1584937]Changing the Base Policy
 
      	 [bookmark: pgfId-1584824]Allowing Rule Updates to Modify a System-Provided Base Policy
 
     
 
    
 
     
      [bookmark: pgfId-1578576][bookmark: 23026]Understanding System-Provided Base Policies
 
     [bookmark: pgfId-1625755]License: Protection
 
     [bookmark: pgfId-1626207]Cisco delivers several pairs of network analysis and intrusion policies with the FireSIGHT System. By using system-provided network analysis and intrusion policies, you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states, as well as provides the initial configurations for preprocessors and other advanced settings. You can use these system-provided policies as-is, or you can use them as the base for custom policies.
 
     [bookmark: pgfId-1626255]If you use a system-provided policy as your base, importing rule updates may modify settings in your base policy. However, you can configure a custom policy to not automatically make these changes to its system-provided base policy. This allows you to update system-provided base policies manually, on a schedule independent of rule update imports. In either case, changes that a rule update makes to your base policy do not change or override settings in your My Changes or any other layer. For more information, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
     [bookmark: pgfId-1626211]System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. For more information, see Understanding the System-Provided Policies.
 
    
 
     
      [bookmark: pgfId-1580218][bookmark: 30778]Understanding Custom Base Policies
 
     [bookmark: pgfId-1626385]License: Protection
 
     [bookmark: pgfId-1580219]If you do not want to use a system-provided policy as the base policy in your network analysis or intrusion policy, you can use a custom policy as your base. You can tune settings in custom policies to inspect traffic in ways that matter most to you so you can improve both the performance of your managed devices and your ability to respond effectively to the events they generate. 
 
     [bookmark: pgfId-1583459]You can chain up to five custom policies, with four of the five using one of the other four previously created policies as its base policy; the fifth must use a system-provided policy as its base. 
 
     [bookmark: pgfId-1583149]Changes you make to a custom policy that you use as the base for another policy are automatically used as the default settings the of policy that uses the base. Additionally, because all policies have a system-provided policy as the eventual base in a policy chain, importing a rule update may affect your policy even if you use a custom base policy. If the first custom policy in a chain (the one that uses the system-provided policy as its base) allows rule updates to modify its base policy, your policy may be affected. For information on changing this setting, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
     [bookmark: pgfId-1583364]Regardless of how they are made, changes to your base policy—whether by a rule update or when you modify a custom policy that you use as a base policy—do not change or override settings in your My Changes or any other layer.
 
    
 
     
      [bookmark: pgfId-1584211][bookmark: 35932][bookmark: 78384]Changing the Base P[bookmark: marker-1584209]olic[bookmark: marker-1584210]y
 
     [bookmark: pgfId-1584219]License: Protection
 
     [bookmark: pgfId-1584220]You can select a different base policy for your network analysis or intrusion policy and, optionally, allow rule updates to modify a system-provided base policy, without affecting modifications in higher layers.
 
     [bookmark: pgfId-1584221]To change the base policy:
 
     [bookmark: pgfId-1584225]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1584226]Step 1 While editing your policy, click Policy Information in the navigation panel.
 
     [bookmark: pgfId-1584227]The Policy Information page appears.
 
     [bookmark: pgfId-1584228]Step 2 Select a base policy from the Base Policy drop-down list.
 
     [bookmark: pgfId-1584229]Step 3 Optionally, if you choose a system-provided base policy, click Manage Base Policy to specify whether intrusion rule updates can automatically modify your base policy. 
 
     [bookmark: pgfId-1584233]For more information, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
     [bookmark: pgfId-1584234]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626402]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1584240][bookmark: 62976]Allowing Rule Updates to Modify a System-Provided Base Policy
 
     [bookmark: pgfId-1584247]License: Protection
 
     [bookmark: pgfId-1623160]Rule updates that you import provide system-provided policies with modified network analysis preprocessor settings, modified intrusion policy advanced settings, new and updated intrusion rules, and modified states for existing rules. Rule updates can also delete rules and provide new rule categories and default variables. See Importing Rule Updates and Local Rule Files for more information.
 
     [bookmark: pgfId-1587514]Rule updates always modify system-provided policies with any changes to preprocessors, advanced settings, and rules. Changes to default variables and rule categories are handled at the system level. See Understanding System-Provided Base Policies for more information.
 
     [bookmark: pgfId-1587683]When you use a system-provided policy as your base policy, you can allow rule updates to modify your base policy which, in this case, is a copy of the system-provided policy. If you allow rule updates to update your base policy, a new rule update makes the same changes in your base policy that it makes to the system-provided policy that you use as your base policy. If you have not modified the corresponding setting, a setting in your base policy determines the setting in your policy. However, rule updates do not override changes you make in your policy. 
 
     [bookmark: pgfId-1587684]If you do not allow rule updates to update your base policy, you can manually update your base policy after importing one or more rule updates.
 
     [bookmark: pgfId-1623286]Rule updates always delete intrusion rules that VRT deletes, regardless of the rule state in your intrusion policy or whether you allow rule updates to update your base intrusion policy. Until you reapply your changes to network traffic, rules in your currently applied intrusion policies behave as follows:
 
      
      	 [bookmark: pgfId-1623287]Disabled rules remain disabled.
 
      	 [bookmark: pgfId-1584273]Rules set to Generate Events continue to generate events when triggered.
 
      	 [bookmark: pgfId-1584274]Rules set to Drop and Generate Events continue to generate events and drop offending packets when triggered.
 
     
 
     [bookmark: pgfId-1587731]Rule updates do not modify a custom base policy unless both of the following conditions are met:
 
      
      	 [bookmark: pgfId-1584279]You allow rule updates to modify the system-provided base policy of the parent policy, that is, the policy that originated the custom base policy.
 
      	 [bookmark: pgfId-1584280]You have not made changes in the parent policy that override the corresponding settings in the parent’s base policy.
 
     
 
     [bookmark: pgfId-1584281]When both conditions are met, changes in the rule update are passed to the child policy, that is, the policy using the custom base policy, when you save the parent policy.
 
     [bookmark: pgfId-1584282]For example, if a rule update enables a previously disabled intrusion rule, and you have not modified the rule’s state in the parent intrusion policy, the modified rule state is passed to the base policy when you save the parent policy.
 
     [bookmark: pgfId-1584283]Likewise, if a rule update modifies a default preprocessor setting and you have not modified the setting in the parent network analysis policy, the modified setting is passed to the base policy when you save the parent policy. 
 
     [bookmark: pgfId-1590026]See Changing the Base Policy for more information.
 
     [bookmark: pgfId-1584287]To allow rule updates to modify a system-provided base policy:
 
     [bookmark: pgfId-1584291]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1584292]Step 1 While editing a policy that uses a system-provided policy as its base policy, click Policy Information in the navigation panel.
 
     [bookmark: pgfId-1584293]The Policy Information page appears.
 
     [bookmark: pgfId-1584294]Step 2 Click Manage Base Policy.
 
     [bookmark: pgfId-1584295]The Base Policy summary page appears.
 
     [bookmark: pgfId-1584296]Step 3 Select or clear the Update when a new Rule Update is installed check box. 
 
     [bookmark: pgfId-1627011]When you save your policy with the check box cleared and then import a rule update, an Update Now button appears on the Base Policy summary page and the status message on the page updates to inform you that the policy is out of date. Optionally, you can click Update Now to update your base policy with the changes in the most recently imported rule update.
 
     [bookmark: pgfId-1584298]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1579609]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533679][bookmark: 24866]Understanding the FireSIGHT Recommendations Layer
 
     [bookmark: pgfId-1534144]License: Protection
 
     [bookmark: pgfId-1537779]When you generate rule state recommendations in an intrusion policy, you can choose whether to automatically modify rule states based on the recommendations. See Tailoring Intrusion Protection to Your Network Assetsfor more information.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1539668]Note that this layer is unique to intrusion policies.
 
     [bookmark: pgfId-1590700]If you subsequently choose not to use recommended rule states, the system removes the FireSIGHT Recommendations layer. You cannot manually delete this layer, but you can add and remove it by choosing to use or not use recommended rule states.
 
     [bookmark: pgfId-1590710]Adding the FireSIGHT Recommendations layer adds a FireSIGHT Recommendations link under Policy Layers in the navigation panel. This link leads you to a read-only view of the FireSIGHT Recommendations layer page where you can access a recommendation-filtered view of the Rules page in read-only mode. See Tuning Intrusion Policies Using Rules for more information on working with rules on the Rules page.
 
     [bookmark: pgfId-1540271]Using recommended rule states also adds a Rules sublink beneath the FireSIGHT Recommendations link in the navigation panel. The Rules sublink provides access to a read-only display of the Rules page in the FireSIGHT Recommendations layer. Note the following in this view:
 
      
      	 [bookmark: pgfId-1537816]When there is no rule state icon in the state column, the state is inherited from the base policy.
 
      	 [bookmark: pgfId-1537820]When there is no rule state icon in the FireSIGHT Recommendations column in this or other Rules page views, there is no recommendation for this rule.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1625387]Tip When a rule state is not recommended, the rule’s overhead rating was higher than the setting for Recommendation Threshold (By Rule Overhead) when recommendations were generated. See Understanding Rule Overhead for more information.
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1625392][bookmark: 44831]Managing Layers
 
    [bookmark: pgfId-1625399]License: Protection
 
    [bookmark: pgfId-1625695]The Policy Layers page provides a single-page summary of the complete layer stack for your network analysis or intrusion policy. On this page you can add shared and unshared layers, copy, merge, move, and delete layers, access the summary page for each layer, and access configuration pages for enabled, disabled, and overridden configurations within each layer.
 
    [bookmark: pgfId-1619530]For each layer, you can view the following information:
 
     
     	 [bookmark: pgfId-1606955]whether the layer is a built-in, shared user, or unshared user layer
 
     	 [bookmark: pgfId-1607035]which layers contain the highest, that is the effective, preprocessor or advanced setting configurations, by feature name
 
     	 [bookmark: pgfId-1607190]in an intrusion policy, the number of intrusion rules whose states are set in the layer, and the number of rules set to each rule state. 
 
    
 
    [bookmark: pgfId-1607482]The feature name in the summary for each layer indicates which configurations are enabled, disabled, overridden, or inherited in the layer, as follows:
 
     
      [bookmark: pgfId-1607504]
 
      
       
        
         
         	 
           
           [bookmark: pgfId-1607485]When the feature is... 
          
  
         	 
           
           [bookmark: pgfId-1607487]The feature name is... 
          
  
        
 
         
         	[bookmark: pgfId-1607489]enabled in the layer
  
         	[bookmark: pgfId-1607491]written in plain text
  
        
 
         
         	[bookmark: pgfId-1607493]disabled in the layer
  
         	[bookmark: pgfId-1607495]struck out
  
        
 
         
         	[bookmark: pgfId-1607497]overridden by the configuration in a higher layer
  
         	[bookmark: pgfId-1607499]written in italic text
  
        
 
         
         	[bookmark: pgfId-1607501]inherited from a lower layer
  
         	[bookmark: pgfId-1607503]not present
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1607927]This page also provides a summary of the net effect of all enabled preprocessors (network analysis) or advanced settings (intrusion) and, for intrusion policies, intrusion rules.
 
     [bookmark: pgfId-1540404]The following table lists the actions available on the Policy Layers page.
 
     [bookmark: pgfId-1609566]
 
      
      
 
      [bookmark: pgfId-1610744]See Sharing Layers Between Policies, Configuring Preprocessors and Advanced Settings in Layers, and Configuring Intrusion Rules in Layers for information on actions you can take on the summary page for a layer.
 
      
 
       
        
        [bookmark: pgfId-1609429]Table 24-1 [bookmark: 85114]Network Analysis and Intrusion Policy Layer Configuration Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1609433]To... 
          
  
         	 
           
           [bookmark: pgfId-1609435]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1609497]display the Policy Information page
  
         	[bookmark: pgfId-1609499]click Policy Summary.
 [bookmark: pgfId-1609503]See Tuning Intrusion Policies Using Rules, Getting Started with Network Analysis Policies, and Getting Started with Intrusion Policies for information on the actions you can take on the Policy Information page.
  
        
 
         
         	[bookmark: pgfId-1609505]display the summary page for a layer
  ) to access the read-only summary page for a shared layer. 
        
 
         
         	[bookmark: pgfId-1609542]access a layer-level preprocessor or advanced setting configuration page
  
         	[bookmark: pgfId-1609544]click the feature name in the row for the layer. Note that configuration pages are read-only in the base policy and in shared layers. See Configuring Preprocessors and Advanced Settings in Layers for more information.
  
        
 
         
         	[bookmark: pgfId-1609553]access a layer-level rule configuration page filtered by rule state type
  ) in the summary for the layer. No rules are displayed if the layer contains no rules set to the selected rule state. 
        
 
         
         	[bookmark: pgfId-1609744]add a layer to your policy
  
         	[bookmark: pgfId-1609746]see Adding a Layer.
  
        
 
         
         	[bookmark: pgfId-1620016]add a shared layer from another policy
  
         	[bookmark: pgfId-1620021]see Sharing Layers Between Policies.
  
        
 
         
         	[bookmark: pgfId-1611880]change a layer’s name or description
  
         	[bookmark: pgfId-1611882]see Changing a Layer's Name and Description.
  
        
 
         
         	[bookmark: pgfId-1610518]move, copy, or delete a layer
  
         	[bookmark: pgfId-1610523]see Moving, Copying, and Deleting Layers.
  
        
 
         
         	[bookmark: pgfId-1610088]merge a layer into the next layer beneath it
  
         	[bookmark: pgfId-1610093]see Merging Layers.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1540582]To use the Policy Layers page:
 
     [bookmark: pgfId-1591879]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1591880]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1591892]The Policy Layers summary page appears.
 
     [bookmark: pgfId-1593314]Step 2 You can take any of the actions in the Network Analysis and Intrusion Policy Layer Configuration Actions table.
 
     [bookmark: pgfId-1594776]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1593282]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537274][bookmark: 49526]Adding a Layer
 
     [bookmark: pgfId-1537281]License: Protection
 
     [bookmark: pgfId-1541438]You can add up to 200 layers to a network analysis or intrusion policy. When you add a layer, it appears as the highest layer in your policy. The initial state is Inherit for all features and, in an intrusion policy, no event filtering, dynamic state, or alerting rule actions are set.
 
     [bookmark: pgfId-1542031]To add a layer to your network analysis or intrusion policy:
 
     [bookmark: pgfId-1542035]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1542179]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1542180]The Policy Layers page appears.
 ) next to User Layers. 
     
 
     [bookmark: pgfId-1541457]The Add Layer pop-up window appears.
 
     [bookmark: pgfId-1542385]Step 3 Type a unique layer Name and click OK.
 
     [bookmark: pgfId-1594540]The new layer appears as the topmost layer under User Layers.
 
     [bookmark: pgfId-1594888]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626428]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1594542][bookmark: 40211]Changing a Layer's Name and Description
 
     [bookmark: pgfId-1542527]License: Protection
 
     [bookmark: pgfId-1542576]You can change the name of a user-configurable layer in your network analysis or intrusion policy and, optionally, add or modify a description that is visible when you edit the layer.
 
     [bookmark: pgfId-1542720]To change a layer’s name and add or modify its description:
 
     [bookmark: pgfId-1542724]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1542725]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1542726]The Policy Layers page appears.
 ) next to the user layer you want to edit. 
     
 
     [bookmark: pgfId-1542942]The summary page for the layer appears.
 
     [bookmark: pgfId-1542934]Step 3 You can take the following actions:
 
      
       
       	 [bookmark: pgfId-1543015]Modify the layer  Name .
 
       	 [bookmark: pgfId-1543057]Add or modify the layer  Description .
 
      
 
     
 
     [bookmark: pgfId-1594970]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626445]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533737][bookmark: 51051]Moving, Copying, and Deleting Layers
 
     [bookmark: pgfId-1534300]License: Protection
 
     [bookmark: pgfId-1543242]You can copy, move, or delete a user layer in your network analysis or intrusion policy, including the initial My Changes layer. Note the following considerations:
 
      
      	 [bookmark: pgfId-1543383]When you copy a layer, the copy appears as the highest layer.
 
      	 [bookmark: pgfId-1543541]Copying a shared layer creates an unshared copy which, optionally, you can then share with other policies.
 
      	 [bookmark: pgfId-1543409]You cannot delete a shared layer; a layer with sharing enabled that you have not shared with another policy is not a shared layer.
 
     
 
     [bookmark: pgfId-1543639]To copy, move, or delete a layer:
 
     [bookmark: pgfId-1543643]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1543644]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1543645]The Policy Layers page appears.
 
     [bookmark: pgfId-1543651]Step 2 You can take the following actions:
 
      
      	 [bookmark: pgfId-1544120]To copy a layer, click the copy icon (
 
      [image: ] ) for the layer you want to copy. 
     
 
     [bookmark: pgfId-1544121]The page refreshes and a copy of the layer appears as the highest layer.
 
      
       
       	 [bookmark: pgfId-1544122]To move a layer up or down within the User Layers page area, click any open area in the layer summary and drag until the position arrow (
 
      
 
      [image: ] ) points to a line above or below a layer where you want to move the layer. 
     
 
     [bookmark: pgfId-1544123]The screen refreshes and the layer appears in the new location.
 
      
       
       	 [bookmark: pgfId-1544124]To delete a layer, click the delete icon (
 
      
 
      [image: ] ) for the layer you want to delete, then click 
       OK 
     
 
     [bookmark: pgfId-1544125]The page refreshes and the layer is deleted.
 
     [bookmark: pgfId-1595073]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626498]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533738][bookmark: 31907]Merging Layers
 
     [bookmark: pgfId-1627076]License: Protection
 
     [bookmark: pgfId-1619046]You can merge a user-configurable layer in your network analysis or intrusion policy with the next user layer beneath it. A merged layer retains all settings that were unique to either layer, and accepts the settings from the higher layer if both layers included settings for the same preprocessor, intrusion rule, or advanced setting. The merged layer retains the name of the lower layer.
 
     [bookmark: pgfId-1544586]In the policy where you create a shared layer that you add to other policies, you can merge an unshared layer immediately above the shared layer with the shared layer, but you cannot merge the shared layer with an unshared layer beneath it.
 
     [bookmark: pgfId-1544558]In a policy where you add a shared layer that you created in another policy, you can merge the shared layer into an unshared layer immediately beneath it and the resulting layer is no longer shared; you cannot merge an unshared layer into a shared layer beneath it.
 
     [bookmark: pgfId-1544602]To merge a user layer with a user layer beneath it:
 
     [bookmark: pgfId-1544606]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1544607]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1544608]The Policy Layers page appears.
 . 
     
 
     [bookmark: pgfId-1544614]The page refreshes and the layer is merged with the layer beneath it. 
 
     [bookmark: pgfId-1595199]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626539]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1545877][bookmark: 91343]Sharing Layers Between Policies
 
     [bookmark: pgfId-1545884]License: Protection
 
     [bookmark: pgfId-1545978]You can share a user-configurable layer with other policies of the same type (intrusion or network analysis). When you modify a configuration within a shared layer and then commit your changes, the system updates all policies that use the shared layer and provides you with a list of all affected policies. You can only modify shared layer feature configurations in the policy where you created the layer.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1545988]The master policy in the figure includes a company-wide layer with settings applicable to the policies at Site A and Site B. It also includes site-specific layers for each policy. For example, in the case of a network analysis policy Site A might not have web servers on the monitored network and would not require the protection or processing overhead of the HTTP Inspect preprocessor, but both sites would likely require TCP stream preprocessing. You could enable TCP stream processing in the company-wide layer that you share with both sites, disable the HTTP Inspect preprocessor in the site-specific layer that you share with Site A, and enable the HTTP Inspect preprocessor in the site-specific layer that you share with Site B. By editing configurations in a higher layer in the site-specific policies, you could also further tune the policy for each site if necessary with any configuration adjustments.
 
     [bookmark: pgfId-1545989]It is unlikely that the flattened net settings in the example master policy would be useful for monitoring traffic, but the time saved in configuring and updating the site-specific policies makes this a useful application of policy layers. 
 
     [bookmark: pgfId-1545990]Many other layer configurations are possible. For example, you could define policy layers by company, by department, by network, or even by user. In the case of an intrusion policy, you could also include advanced settings in one layer and rule settings in another.
 
      
       
     
 
     
 
     [bookmark: pgfId-1545995]Tip You cannot add a shared layer to a policy when your base policy is a custom policy where the layer you want to share was created. When you attempt to save your changes, an error message indicates that the policy includes a circular dependency. See Understanding Custom Base Policies for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1544420]To share a layer with other policies, you must do the following:
 
      
      	 [bookmark: pgfId-1546500]Enable sharing on the layer summary page of the layer you want to share.
 
      	 [bookmark: pgfId-1546756]Add the shared layer on the Policy Layers page of the policy where you want to share it.
 
     
 
     [bookmark: pgfId-1595707]You cannot disable sharing for a layer that is in use in another policy; you must first delete the layer from the other policy or delete the other policy.
 
     [bookmark: pgfId-1546808]To enable or disable sharing a layer with other policies:
 
     [bookmark: pgfId-1546812]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1546813]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1546814]The Policy Layers page appears.
 ) next to the layer you want to share with other policies. 
     
 
     [bookmark: pgfId-1547094]The summary page for the layer appears.
 
     [bookmark: pgfId-1546927]Step 3 Select (enable) or clear (disable) the Sharing check box.
 
     [bookmark: pgfId-1595292]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1630638]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1546781]To add a shared layer to your policy:
 
     [bookmark: pgfId-1546785]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1546786]Step 1 While editing your policy, click Policy Layers in the navigation panel.
 
     [bookmark: pgfId-1546787]The Policy Layers page appears.
 ) next to User Layers. 
     
 
     [bookmark: pgfId-1546997]The Add Shared Layer pop-up window appears.
 
     [bookmark: pgfId-1548073]Step 3 Select the shared layer you want to add from the Add Shared Layer drop-down list, then click OK.
 
     [bookmark: pgfId-1548074]The Policy Layers summary page appears and the shared layer you selected appears as the highest layer in your policy. 
 
     [bookmark: pgfId-1546757]If there are no shared layers in any other policies, no drop-down list appears; click OK or Cancel on the pop-up window to return to the Policy Layers summary page.
 
     [bookmark: pgfId-1595323]Step 4 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626574]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1551703][bookmark: 34253]Configuring Intrusion Rules in Lay[bookmark: marker-1551701]er[bookmark: marker-1551702]s
 
     [bookmark: pgfId-1551710]License: Protection
 
     [bookmark: pgfId-1624210]In an intrusion policy, you can set the rule state, event filtering, dynamic state, alerting, and rule comments for a rule in any user-configurable layer. After accessing the layer where you want to make your changes, you add settings on the Rules page for the layer the same as you would on the intrusion policy Rules page; see Tuning Intrusion Policies Using Rules. 
 
     [bookmark: pgfId-1624217]You can view individual layer settings on the Rules page for the layer, or view the net effect of all settings on the policy view of the Rules page. When you modify rule settings on the policy view of the Rules page, you are modifying the highest user-configurable layer in the policy. You can switch to another layer using the layer drop-down list on any Rules page.
 
     [bookmark: pgfId-1551712]The following table describes the effects of configuring the same type of setting in multiple layers.
 
     [bookmark: pgfId-1551774]
 
      
       
        
        [bookmark: pgfId-1630757]Table 24-2 [bookmark: 95517]Layer Rule Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1630763]You can set... 
          
  
         	 
           
           [bookmark: pgfId-1630765]Of this setting type... 
          
  
         	 
           
           [bookmark: pgfId-1630767]To... 
          
  
        
 
         
         	[bookmark: pgfId-1630769]one
  
         	[bookmark: pgfId-1630771]rule state
  
         	[bookmark: pgfId-1630773]override a rule state set for the rule in a lower layer, and ignore all thresholds, suppressions, rate-based rule states, and alerts for that rule configured in lower layers. See Setting Rule States for more information.
 [bookmark: pgfId-1630777]If you want a rule to inherit its state from the base policy or a lower layer, set the rule state to Inherit. Note that when you are working on the intrusion policy Rules page, you cannot set a rule state to Inherit.
 [bookmark: pgfId-1630778]Note also that rule state settings are color-coded when you view them on the Rules page for a specific layer: rules whose effective state is set in a lower layer are highlighted in yellow; rules whose effective state is set in a higher layer are highlighted in red; rules whose effective state is set in the current layer are not highlighted. Because the intrusion policy Rules page is a composite view of the net effect of all rule settings, rule states are not color-coded on this page.
  
        
 
         
         	[bookmark: pgfId-1630780]one
  
         	[bookmark: pgfId-1630782]threshold
SNMP alert
  
         	[bookmark: pgfId-1630784]override a setting of the same type for the rule in a lower layer. Note that setting a threshold overwrites any existing threshold for the rule in the layer. See Configuring Event Thresholding and Adding SNMP Alerts for more information.
  
        
 
         
         	[bookmark: pgfId-1630792]one or more
  
         	[bookmark: pgfId-1630794]suppression
rate-based rule state
  
         	[bookmark: pgfId-1630796]cumulatively combine settings of the same type for each selected rule down to the first layer where a rule state is set for the rule. Settings below the layer where a rule state is set are ignored. See Configuring Suppression Per Intrusion Policy and Adding Dynamic Rule States for more information.
  
        
 
         
         	[bookmark: pgfId-1630804]one or more
  
         	[bookmark: pgfId-1630806]comment
  
         	[bookmark: pgfId-1630808]add a comment to a rule. Comments are rule-specific, not policy- or layer-specific. You can add one or more comments to a rule in any layer. See Adding a Rule Comment for a Rule for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1551775]For example, if you set a rule state to Drop and Generate Events in one layer and to Disabled in a higher layer, the intrusion policy Rules page shows that the rule is disabled.
 
     [bookmark: pgfId-1551776]In another example, if you set a source-based suppression for a rule to 192.168.1.1 in one layer, and you also set a destination-based suppression for the rule to 192.168.1.2 in another layer, the Rules page shows that the cumulative effect is to suppress events for the source address 192.168.1.1 and the destination address 192.168.1.2. Note that suppression and rate-based rule state settings cumulatively combine settings of the same type for each selected rule down to the first layer where a rule state is set for the rule. Settings below the layer where a rule state is set are ignored.
 
     [bookmark: pgfId-1551777]To modify rules in a layer:
 
     [bookmark: pgfId-1551781]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1551782]Step 1 While editing your intrusion policy, expand Policy Layers in the navigation panel and expand the policy layer you want to modify.
 
     [bookmark: pgfId-1551794]Step 2 Click Rules immediately beneath the policy layer you want to modify.
 
     [bookmark: pgfId-1551795]The Rules page for the layer appears.
 
     [bookmark: pgfId-1551799]You can modify any of the settings in the Layer Rule Settings table. See Tuning Intrusion Policies Using Rules for more information on configuring intrusion rules.
 
     [bookmark: pgfId-1630557]To delete an individual setting from an editable layer, double-click the rule message on the Rules page for the layer to display rule details. Click Delete next to the setting you want to delete, then click OK twice.
 
     [bookmark: pgfId-1630558]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626607]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1552688][bookmark: 16548]Removing Multi-Layer Rule Settings
 
     [bookmark: pgfId-1552695]License: Protection
 
     [bookmark: pgfId-1552696]You can select one or more rules on the intrusion policy Rules page and then simultaneously remove a specific type of event filter, dynamic state, or alerting from multiple layers in your intrusion policy.
 
     [bookmark: pgfId-1552697]The system removes the setting type downward through each layer where it is set until it removes all the settings or encounters a layer where a rule state is set for the rule. If it encounters a layer where a rule state is set, it removes the setting from that layer and stops removing the setting type.
 
     [bookmark: pgfId-1552698]When the system encounters the setting type in a shared layer or in the base policy, and if the highest layer in the policy is editable, the system copies the remaining settings and rule state for the rule to that editable layer. Otherwise, if the highest layer in the policy is a shared layer, the system creates a new editable layer above the shared layer and copies the remaining settings and rule state for the rule to that editable layer.
 
      
       
     
 
     
 
     [bookmark: pgfId-1552699]Note Removing rule settings derived from a shared layer or the base policy causes any changes to this rule from lower layers or the base policy to be ignored. To stop ignoring changes from lower layers or the base policy, set the rule state to Inherit on the summary page for the topmost layer. See Setting Rule States for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1552703]To remove rule settings in multiple layers:
 
     [bookmark: pgfId-1602896]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1602897]Step 1 While editing your intrusion policy, click Rules immediately beneath Policy Information in the navigation panel.
 
      
       
     
 
     
 
     [bookmark: pgfId-1602662]Tip You can also select Policy from the layer drop-down list on the Rules page for any layer, or select Manage Rules on the Policy Information page.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1602990]The intrusion policy Rules page appears. 
 
     [bookmark: pgfId-1603012]Step 2 Select the rule or rules from which you want to remove multiple settings. You have the following options:
 
      
       
       	 [bookmark: pgfId-1603013]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1603014]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1603020]See Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy for information on locating rules.
 
     [bookmark: pgfId-1603004]Step 3 You have the following options:
 
      
       
       	 [bookmark: pgfId-1602678]To remove all thresholds for a rule, select  Event Filtering > Remove Thresholds .
 
       	 [bookmark: pgfId-1602679]To remove all suppression for a rule, select  Event Filtering > Remove Suppressions .
 
       	 [bookmark: pgfId-1602680]To remove all rate-based rule states for a rule, select  Dynamic State > Remove Rate-Based Rule States .  
 
       	 [bookmark: pgfId-1602681]To remove all SNMP alert settings for a rule, select  Alerting > Remove SNMP Alerts .  
 
      
 
     
 
     [bookmark: pgfId-1602682]A confirmation pop-up window appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-1602683]Note Removing rule settings derived from a shared layer or the base policy causes any changes to this rule from lower layers or the base policy to be ignored. To stop ignoring changes from lower layers or the base policy, set the rule state to Inherit on the summary page for the topmost layer. See Setting Rule States for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1602687]Step 4 Click OK.
 
     [bookmark: pgfId-1602688]The system removes the selected setting and copies the remaining settings for the rule to the highest editable layer in the policy. See the introduction to this procedure for conditions that affect how the system copies the remaining settings.
 
     [bookmark: pgfId-1602689]Step 5 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626901]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1602693]Accepting Rule Changes from a Custom Base Policy
 
     [bookmark: pgfId-1602700]License: Protection
 
     [bookmark: pgfId-1602702]When a custom network analysis or intrusion policy where you have not added layers uses another custom policy as its base policy, you must set a rule to inherit its rule state if:
 
      
      	 [bookmark: pgfId-1602703]you delete an event filter, dynamic state, or SNMP alert set for the rule in the base policy, and
 
      	 [bookmark: pgfId-1602704]you want the rule to accept subsequent changes that you make to it in the other custom policy that you use as your base policy
 
     
 
     [bookmark: pgfId-1602716]The following procedure explains how to accomplish this. See Removing Multi-Layer Rule Settings to accept settings for these rules in a policy where you have added layers.
 
     [bookmark: pgfId-1602726]To accept rule changes in a policy where you have not added layers:
 
     [bookmark: pgfId-1602730]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1602731]Step 1 While editing your intrusion policy, expand the Policy Layers link in the navigation panel, then expand the My Changes link.
 
     [bookmark: pgfId-1602732]Step 2 Click the Rules link immediately beneath My Changes.
 
     [bookmark: pgfId-1602733]The Rules page for the My Changes layer appears.
 
     [bookmark: pgfId-1586175]Step 3 Select the rule or rules whose settings you want to accept. You have the following options:
 
      
       
       	 [bookmark: pgfId-1586176]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1586177]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1618466]See Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy for information on locating rules.
 
     [bookmark: pgfId-1586178]Step 4 Select Inherit from the Rule State drop-down list.
 
     [bookmark: pgfId-1595416]Step 5 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626922]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1551838][bookmark: 79692]Configuring Preprocessors and Advanced Settings in L[bookmark: marker-1551836]ayers
 
     [bookmark: pgfId-1627965]License: Protection
 
     [bookmark: pgfId-1631049]You use similar mechanisms to configure preprocessors in a network analysis policy and advanced settings in an intrusion policy. You can enable and disable preprocessors on the network analysis Settings page and intrusion policy advanced settings on the intrusion policy Advanced Settings page. These pages also provide summaries of the effective states for all relevant features. For example, if the network analysis SSL preprocessor is disabled in one layer and enabled in a higher layer, the Settings page shows it as enabled. Changes made on these pages appear in the top layer of the policy.
 
     [bookmark: pgfId-1621200]You can also enable or disable preprocessors or advanced settings and access their configuration pages on the summary page for a user-configurable layer. On this page you can modify the layer name and description and configure whether to share the layer with other policies of the same type; see Sharing Layers Between Policies for more information. You can switch to the summary page for another layer by selecting the layer name beneath Policy Layers in the navigation panel. 
 ) appears next to the feature on the summary page for the layer; these disappear when you disable the feature in the layer or set it to Inherit. 
     
 
     [bookmark: pgfId-1604726]Setting the state (enabled or disabled) for a preprocessor or advanced setting overrides the state and configuration settings for that feature in lower layers. If you want a preprocessor or advanced setting to inherit its state and configuration from the base policy or a lower layer, set it to Inherit. Note that the Inherit selection is not available when you are working in the Settings or Advanced Settings page.
 
     [bookmark: pgfId-1604753]Color-coding on each layer summary page indicates as follows whether the effective configuration is in a higher, lower, or the current layer:
 
      
      	 [bookmark: pgfId-1605019]red - the effective configuration is in a higher layer
 
      	 [bookmark: pgfId-1605160]yellow - the effective configuration is in a lower layer
 
      	 [bookmark: pgfId-1605179]unshaded - the effective configuration is in the current layer
 
     
 
     [bookmark: pgfId-1605030]Because the Settings and Advanced Settings pages are composite views of all relevant settings, these page do not use color coding to indicate the positions of effective configurations.
 
     [bookmark: pgfId-1551860]The system uses the configuration in the highest layer where the feature is enabled. Unless you explicitly modify the configuration, the system uses the default configuration. For example, if you enable and modify the network analysis DCE/RPC preprocessor in one layer, and you also enable but do not modify it in a higher layer, the system uses the default configuration in the higher layer.
 
      
      
 
      [bookmark: pgfId-1606139]Note that the Back Orifice preprocessor has no user-configurable options.
 
       
        
        [bookmark: pgfId-1551872]Table 24-3 [bookmark: 42003]Layer Summary Page Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1551876]To... 
          
  
         	 
           
           [bookmark: pgfId-1551878]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1551880]modify the layer name or description
  
         	[bookmark: pgfId-1551882]type a new value for Name or Description.
  
        
 
         
         	[bookmark: pgfId-1551885]share the layer with other intrusion policies
  
         	[bookmark: pgfId-1551887]select Allow this layer to be used by other policies.
 [bookmark: pgfId-1551893]See Sharing Layers Between Policies for more information.
  
        
 
         
         	[bookmark: pgfId-1551897]enable or disable a preprocessor/advanced setting in the current layer
  
         	[bookmark: pgfId-1606240]click Enabled or Disabled next to the feature.
 ) appears on the summary page next to the feature. 
 [bookmark: pgfId-1605937]Disabling removes the sublink and edit icon.
  
        
 
         
         	[bookmark: pgfId-1551911]inherit the preprocessor/advanced setting state and configuration from the settings in the highest layer below the current layer
  
         	[bookmark: pgfId-1619031]click Inherit. 
 [bookmark: pgfId-1551914]The page refreshes and, if the feature was enabled, the feature sublink in the navigation panel and the edit icon no longer appear.
  
        
 
         
         	[bookmark: pgfId-1606028]access the configuration page for an enabled preprocessor/advanced setting
  ) or the feature sublink to modify the current configuration. 
        
 
        
      
 
     
 
     [bookmark: pgfId-1551916]To modify preprocessors/advanced settings in a user layer:
 
     [bookmark: pgfId-1551920]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1551921]Step 1 While editing your policy, expand Policy Layers in the navigation panel, then click the name of the layer you want to modify.
 
     [bookmark: pgfId-1551933]The summary page for the layer appears.
 
     [bookmark: pgfId-1551937]Step 2 You can take any of the actions in the Layer Summary Page Actions table.
 
     [bookmark: pgfId-1595431]Step 3 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1626636]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272]Customizing Traffic [bookmark: 58391]Preprocessing 
      
      
 
     
 
 
    [bookmark: pgfId-1547588]Many of the advanced settings in an access control policy govern intrusion detection and prevention configurations that require specific expertise to configure. Advanced settings typically require little or no modification and are not common to every deployment. 
 
    [bookmark: pgfId-1567231]This chapter explains how to set the following preferences:
 
     
     	 [bookmark: pgfId-1561748]Setting the Default Intrusion Policy for Access Control explains how to change the access control policy’s default intrusion policy, which is used to initially inspect traffic before the system can determine exactly how to inspect that traffic
 
     	 [bookmark: pgfId-1567320]Customizing Preprocessing with Network Analysis Policies explains how to tailor certain traffic preprocessing options to specific security zones, networks, and VLANs by assigning custom network analysis policies to preprocess matching traffic.
 
    
 
    [bookmark: pgfId-1567321]Other chapters describe policy-wide preprocessing and performance options for access control policies. For more information, see:
 
     
     	 [bookmark: pgfId-1567325]Configuring Advanced Transport/Network Settings
 
     	 [bookmark: pgfId-1562017]Tuning Preprocessing in Passive Deployments
 
     	 [bookmark: pgfId-1562018]Tuning Intrusion Prevention Performance
 
     	 [bookmark: pgfId-1562246]Tuning File and Malware Inspection Performance and Storage
 
    
 
   
 
    
     [bookmark: pgfId-1559073][bookmark: 74203]Setting the Default Intrusion Policy for Access Control
 
    [bookmark: pgfId-1559077]License: Any
 
    [bookmark: pgfId-1542816]Each access control policy uses its default intrusion policy to initially inspect traffic before the system can determine exactly how to inspect that traffic. This is needed because sometimes the system must process the first few packets in a connection, allowing them to pass, before it can decide which access control rule (if any) will handle the traffic. However, so that these packets do not reach their destination uninspected, you can use an intrusion policy—called the default intrusion policy—to inspect them and generate intrusion events.
 
    [bookmark: pgfId-1548516]A default intrusion policy is especially useful when performing application control and URL filtering, because the system cannot identify applications or filter URLs before a connection is fully established between the client and the server. For example, if a packet matches all the other conditions in an access control rule with an application or URL condition, it and subsequent packets are allowed to pass until the connection is established and application or URL identification is complete, usually 3 to 5 packets. 
 
    [bookmark: pgfId-1567827]The system inspects these allowed packets with the default intrusion policy, which can generate events and, if placed inline, block malicious traffic. After the system identifies the access control rule or default action that should handle the connection, the remaining packets in the connection are handled and inspected accordingly. 
 
    [bookmark: pgfId-1567487]When you create an access control policy, its default intrusion policy depends on the default action you first chose. Initial default intrusion policies for access control are as follows:
 
     
     	 [bookmark: pgfId-1544036]Balanced Security and Connectivity (a system-provided policy) is the default intrusion policy for an access control policy where you first chose the  Intrusion Prevention default action.
 
     	 [bookmark: pgfId-1550515]No Rules Active is the default intrusion policy for an access control policy where you first chose the  Block all traffic or  Network Discovery default action. Although choosing this option disables intrusion inspection on the allowed packets described above, it can improve performance if you are not interested in intrusion data.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1550516]Note If you are not performing intrusion inspection (for example, in a discovery-only deployment where you are not licensed for Protection), keep the No Rules Active policy as your default intrusion policy. For more information, see IPS or Discovery-Only Performance Considerations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1550532]Note that if you change your default action after you create the access control policy, the default intrusion policy does not automatically change. To change it manually, use the access control policy’s advanced options.
 
    [bookmark: pgfId-1545589]To change an access control policy’s default intrusion policy:
 
    [bookmark: pgfId-1545593]Access: Admin/Access Admin/Network Admin
 
    
 ) next to the Network Analysis and Intrusion Policies section. 
    
 
    [bookmark: pgfId-1545598]The Network and Analysis Policies dialog box appears.
 
    [bookmark: pgfId-1546115]Step 2 From the Intrusion Policy used before Access Control rule is determined drop-down list, select a default intrusion policy. You can choose a system- or user-created policy. 
 ) to edit the policy in a new window. You cannot edit system-provided policies. 
    
 
    [bookmark: pgfId-1576012]Step 3 Choose the variable set matched with the selected policy.
 ). If you do not change the variable set, the system uses a default set. For more information, see 
    Working with Variable Sets. 
    
 
    [bookmark: pgfId-1546027]Step 4 Click OK to save your changes.
 
    [bookmark: pgfId-1545569]You must apply the access control policy for your changes to take effect.
 
    [bookmark: pgfId-1548114]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1547089][bookmark: 25956]Customizing Preprocessing with Network Analysis Policies
 
    [bookmark: pgfId-1552527]License: Any
 
    [bookmark: pgfId-1552607]Supported Devices: feature dependent
 
    [bookmark: pgfId-1554720]Network analysis policies govern how traffic is decoded and preprocessed so that it can be further evaluated, especially for anomalous traffic that might signal an intrusion attempt. This traffic preprocessing occurs after Security Intelligence blacklisting and traffic decryption, but before intrusion policies inspect packets in detail. By default, the system-provided Balanced Security and Connectivity network analysis policy applies to all traffic handled by an access control policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-1560482]Tip The system-provided Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1554869]A simple way to tune preprocessing is to create and use a custom network analysis policy as the default; see Creating a Custom Network Analysis Policy. Tuning options available vary by preprocessor.
 
    [bookmark: pgfId-1567880]For advanced users with complex deployments, you can create multiple network analysis policies, each tailored to preprocess traffic differently. Then, you can configure the system to use those policies to govern the preprocessing of traffic using different security zones, networks, or VLANs. (Note that ASA FirePOWER devices cannot restrict preprocessing by VLAN.) 
 
    [bookmark: pgfId-1568511]To accomplish this, you add custom network analysis rules to your access control policy. Each rule has:
 
     
     	 [bookmark: pgfId-1568070]a set of rule conditions that identifies the specific traffic you want to preprocess
 
     	 [bookmark: pgfId-1568071]an associated network analysis policy that you want to use to preprocess traffic that meets all the rules’ conditions
 
    
 
    [bookmark: pgfId-1572901]When it is time for the system to preprocess traffic, it matches packets to network analysis rules in top-down order by rule number. Traffic that does not match any network analysis rules is preprocessed by the default network analysis policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-1572980]Note If you disable a preprocessor but the system needs to evaluate preprocessed packets against an enabled intrusion or preprocessor rule, the system automatically enables and uses the preprocessor although it remains disabled in the network analysis policy web interface. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. Because preprocessing and intrusion inspection are so closely related, you must be careful that you allow the network analysis and intrusion policies examining a single packet to complement each other. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1533780]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1534025]Setting the Default Network Analysis Policy for Access Control
 
     	 [bookmark: pgfId-1559211]Specifying Traffic to Preprocess Using Network Analysis Rules
 
     	 [bookmark: pgfId-1547461]Managing Network Analysis Rules
 
    
 
     
      [bookmark: pgfId-1559090][bookmark: 12571]Setting the Default Network Analysis Policy for Access Control
 
     [bookmark: pgfId-1559346]License: Any
 
     [bookmark: pgfId-1559273]By default, the system-provided Balanced Security and Connectivity network analysis policy applies to all traffic handled by an access control policy. If you add network analysis rules to tailor traffic preprocessing options, the default network analysis policy preprocesses all traffic not handled by those rules.
 
     [bookmark: pgfId-1560185]An access control policy’s advanced settings allow you to change this default policy.
 
     [bookmark: pgfId-1560685]To change an access control policy’s default network analysis policy:
 
     [bookmark: pgfId-1560689]Access: Admin/Access Admin/Network Admin
 
     
 ) next to the Network Analysis and Intrusion Policies section. 
     
 
     [bookmark: pgfId-1560694]The Network and Analysis Policies dialog box appears.
 
     [bookmark: pgfId-1560695]Step 2 From the Default Network Analysis Policy drop-down list, select a default network analysis policy. You can choose a system- or user-created policy. 
 ) to edit the policy in a new window. You cannot edit system-provided policies. 
     
 
     [bookmark: pgfId-1560703]Step 3 Click OK to save your changes,.
 
     [bookmark: pgfId-1560704]You must apply the access control policy for your changes to take effect.
 
     [bookmark: pgfId-1560705]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1559931][bookmark: 31724]Specifying Traffic to Preprocess Using Network Analysis Rules
 
     [bookmark: pgfId-1559935]License: Any
 
     [bookmark: pgfId-1553432]Supported Devices: feature dependent
 
     [bookmark: pgfId-1558158]Within your access control policy’s advanced settings, you can use network analysis rules to tailor preprocessing configurations to network traffic. Similar to access control rules, network analysis rules are numbered, starting at 1.
 
     [bookmark: pgfId-1557396]When it is time for the system to preprocess traffic, it matches packets to network analysis rules in top-down order by ascending rule number, and preprocesses traffic according to the first rule where all the rule’s conditions match. The conditions you can add to a rule are described in the following table.
 
      
       [bookmark: pgfId-1559868]
 
       
        
         
         [bookmark: pgfId-1559827]Table 25-1 [bookmark: 69858]Network Analysis Rule Condition Types 
 
         
         
          
          	 
            
            [bookmark: pgfId-1559833]This Condition... 
           
  
          	 
            
            [bookmark: pgfId-1559835]Matches Traffic... 
           
  
          	 
            
            [bookmark: pgfId-1559837]Details 
           
  
         
 
          
          	[bookmark: pgfId-1559839]Zones
  
          	[bookmark: pgfId-1559841]entering or leaving a device via an interface in a specific security zone
  
          	[bookmark: pgfId-1559843]A security zone is a logical grouping of one or more interfaces according to your deployment and security policies. Interfaces in a zone may be located across multiple devices. To build a zone condition, see Preprocessing Traffic Per Zone.
  
         
 
          
          	[bookmark: pgfId-1559848]Networks
  
          	[bookmark: pgfId-1559850]by its source or destination IP address, country, or continent
  
          	[bookmark: pgfId-1559852]You can explicitly specify IP addresses. To build a network condition, see Preprocessing Traffic Per Network.
  
         
 
          
          	[bookmark: pgfId-1559857]VLAN Tags
  
          	[bookmark: pgfId-1559859]tagged by VLAN
  
          	[bookmark: pgfId-1559861]The system uses the innermost VLAN tag to identify a packet by VLAN. Note that the ASA FirePOWER cannot restrict preprocessing by VLAN. To build a VLAN condition, see Preprocessing Traffic Per VLAN.
  
         
 
         
       
 
      
 
      [bookmark: pgfId-1559869]If you do not configure a particular condition for a rule, the system does not match traffic based on that criterion. For example, a rule with a network condition but no zone condition evaluates traffic based on its source or destination IP address, regardless of its ingress or egress interface. Traffic that does not match any network analysis rules is preprocessed by the default network analysis policy.
 
      [bookmark: pgfId-1534346]To add a custom network analysis rule:
 
      [bookmark: pgfId-1535942]Access: Admin/Access Admin/Network Admin
 
      
 ) next to the Intrusion and Network Analysis Policies section. 
      
 
      [bookmark: pgfId-1534698]The Network and Analysis Policies dialog box appears. If you have not added any custom network analysis rules, the web interface indicates that you have No Custom Rules, otherwise it displays how many you have configured.
 
       
        
      
 
      
 
      [bookmark: pgfId-1570023]Tip Click Network Analysis Policy List to display the Network Analysis Policy page in a new window. Use this page to view and edit your custom network analysis policies; see Managing Network Analysis Policies
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1534695]Step 2 Next to Network Analysis Rules, click the statement that indicates how many custom rules you have.
 
      [bookmark: pgfId-1535219]The dialog box expands to show the custom rules, if any.
 
      [bookmark: pgfId-1535282]Step 3 Click Add Rule.
 
      [bookmark: pgfId-1535306]The network analysis rule editor appears.
 
      [bookmark: pgfId-1535345]Step 4 Build your rule’s conditions. You can restrict NAP preprocessing using the following criteria:
 
       
        
        	 [bookmark: pgfId-1535464]Preprocessing Traffic Per Zone
 
        	 [bookmark: pgfId-1535474]Preprocessing Traffic Per Network
 
        	 [bookmark: pgfId-1535696]Preprocessing Traffic Per VLAN
 
       
 
      
 
      [bookmark: pgfId-1538743]Step 5 Associate a network analysis policy with the rule by clicking the Network Analysis tab and choosing a policy from the Network Analysis Policy drop-down list.
 ) to edit the policy in a new window. You cannot edit system-provided policies. 
      
 
      [bookmark: pgfId-1535883]Step 6 Click Add.
 
      [bookmark: pgfId-1535698]The rule is added after any other rules. To change the rule’s evaluation order, see Managing Network Analysis Rules.
 
      [bookmark: pgfId-1548197]
 
       
       
 
      
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1535974][bookmark: 76028]Preprocessing Traffic Per Zone
 
     [bookmark: pgfId-1547712]License: Any
 
     [bookmark: pgfId-1536105]Zone conditions in network analysis rules allow you to preprocess traffic by its source and destination security zones. A security zone is a grouping of one or more interfaces, which may be located across multiple devices in a way that makes sense for your deployment and security policies. For more information on creating zones, see Working with Security Zones.
 
     [bookmark: pgfId-1536119]You can add a maximum of 50 zones to each of the Source Zones and Destination Zones in a single zone condition:
 
      
      	 [bookmark: pgfId-1536120]To match traffic  leaving the device from an interface in the zone, add that zone to  Destination Zones . Note that because devices deployed passively do not transmit traffic, you cannot use a zone comprised of passive interfaces in a  Destination Zone  condition.
 
      	 [bookmark: pgfId-1536123]To match traffic  entering the device from an interface in the zone, add that zone to  Source Zones .
 
     
 
     [bookmark: pgfId-1536124]If you add both source and destination zone conditions to a rule, matching traffic must originate from one of the specified source zones and egress through one of the destination zones. 
 
     [bookmark: pgfId-1536125]Note that just as all interfaces in a zone must be of the same type (all inline, all passive, all switched, or all routed), all zones used in a zone condition for an network analysis rule must be of the same type. That is, you cannot write a single rule that matches traffic to or from zones of different types.
 ) indicate invalid configurations, such as zones that contain no interfaces. For details, hover your pointer over the icon. 
     
 
     [bookmark: pgfId-1536249]To preprocess traffic by zone:
 
     [bookmark: pgfId-1536250]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1536251]Step 1 In the access control policy where you want to preprocess traffic by zone, create a new network analysis rule or edit an existing rule.
 
     [bookmark: pgfId-1536252]For detailed instructions, see Specifying Traffic to Preprocess Using Network Analysis Rules.
 
     [bookmark: pgfId-1536253]Step 2 In the network analysis rule editor, select the Zones tab.
 
     [bookmark: pgfId-1536254]The Zones tab appears.
 
     [bookmark: pgfId-1536255]Step 3 Find and select the zones you want to add from the Available Zones. 
 
     [bookmark: pgfId-1536256]To search for zones to add, click the Search by name prompt above the Available Zones list, then type a zone name. The list updates as you type to display matching zones. 
 
     [bookmark: pgfId-1536257]Click to select a zone. To select multiple zones, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-1536258]Step 4 Click Add to Source or Add to Destination to add the selected zones to the appropriate list. 
 
     [bookmark: pgfId-1536259]You can also drag and drop selected zones.
 
     [bookmark: pgfId-1536260]Step 5 Save or continue editing the rule.
 
     [bookmark: pgfId-1536245]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1548224]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1536108][bookmark: 60131]Preprocessing Traffic Per Network
 
     [bookmark: pgfId-1537020]License: Any
 
     [bookmark: pgfId-1537042]Network conditions in network analysis rules allow you to preprocess traffic by its source and destination IP address. You can manually specify the source and destination IP addresses for the traffic you want to preprocess, or you can configure network conditions with network objects, which are reusable and associate a name with one or more IP addresses and address blocks.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537553]Tip After you create a network object, you can use it not only to build network analysis rules, but also to represent IP addresses in various other places in the system’s web interface. You can create these objects using the object manager; you can also create network objects on-the-fly while you are configuring network analysis rules. For more information, see Working with Network Objects.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537562]You can add a maximum of 50 items to each of the Source Networks and Destination Networks in a single network condition:
 
      
      	 [bookmark: pgfId-1537563]To match traffic from an IP address, configure  Source Networks .
 
      	 [bookmark: pgfId-1537564]To match traffic to an IP address, configure  Destination Networks .
 
     
 
     [bookmark: pgfId-1537566]If you add both source and destination network conditions to a rule, matching traffic must originate from one of the specified IP addresses and be destined for one of the destination IP addresses. 
 ) indicate invalid configurations. For details, hover your pointer over the icon. 
     
 
     [bookmark: pgfId-1537593]To preprocess traffic by network:
 
     [bookmark: pgfId-1537597]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1537598]Step 1 In the access control policy where you want to preprocess traffic by network, create a new network analysis rule or edit an existing rule.
 
     [bookmark: pgfId-1537601]For detailed instructions, see Specifying Traffic to Preprocess Using Network Analysis Rules.
 
     [bookmark: pgfId-1537603]Step 2 In the network analysis rule editor, select the Networks tab.
 
     [bookmark: pgfId-1537604]The Networks tab appears.
 
     [bookmark: pgfId-1537605]Step 3 Find and select the networks you want to add from the Available Networks, as follows: 
 
      
       
       	 [bookmark: pgfId-1537606]To add a network object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the 
       Available Networks list; see 
      Working with Network Objects. 
     
 
      
       
       	 [bookmark: pgfId-1537668]To search for networks to add, click the  Search by name or value prompt above the  Available Networks list, then type an object name or the value of one of the object’s components. The list updates as you type to display matching objects. 
 
      
 
     
 
     [bookmark: pgfId-1537607]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select Select All.
 
     [bookmark: pgfId-1537925]Step 4 Click Add to Source or Add to Destination to add the selected objects to the appropriate list. 
 
     [bookmark: pgfId-1537926]You can also drag and drop selected objects.
 
     [bookmark: pgfId-1537927]Step 5 Add any source or destination IP addresses or address blocks that you want to specify manually.
 
     [bookmark: pgfId-1537928]Click the Enter an IP address prompt below the Source Networks or Destination Networks list; then type an IP address or address block and click Add.
 
     [bookmark: pgfId-1537610]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-1537611]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1565263]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537556][bookmark: 59353]Preprocessing Traffic Per VLAN
 
     [bookmark: pgfId-1538775]License: Any
 
     [bookmark: pgfId-1548251]Supported Devices: Any except ASA FirePOWER
 
     [bookmark: pgfId-1567776]VLAN conditions in network analysis rules allow you to control how VLAN-tagged traffic is preprocessed. The system uses the innermost VLAN tag to identify a packet by VLAN. Note that ASA FirePOWER devices cannot restrict preprocessing by VLAN.
 
     [bookmark: pgfId-1567780]When you build a VLAN-based network analysis condition, you can manually specify VLAN tags. Alternately, you can configure VLAN conditions with VLAN tag objects, which are reusable and associate a name with one or more VLAN tags. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1538793]Tip After you create a VLAN tag object, you can use it not only to build network analysis rules, but also to represent VLAN tags in various other places in the system’s web interface. You can create VLAN tag objects either using the object manager or on-the-fly while you are configuring network analysis rules. For more information, see Working with VLAN Tag Objects.
 
      
      
 
     
 
     
 ) indicate invalid configurations. For details, hover your pointer over the icon. 
     
 
     [bookmark: pgfId-1538962]To preprocess traffic by VLAN tag:
 
     [bookmark: pgfId-1538963]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1558516]Step 1 In the access control policy where you want to preprocess traffic by VLAN tag, create a new network analysis rule or edit an existing rule.
 
     [bookmark: pgfId-1558519]For detailed instructions, see Specifying Traffic to Preprocess Using Network Analysis Rules.
 
     [bookmark: pgfId-1538966]Step 2 In the network analysis rule editor, select the VLAN Tags tab.
 
     [bookmark: pgfId-1538967]The VLAN Tags tab appears.
 
     [bookmark: pgfId-1538968]Step 3 Find and select the VLANs you want to add from the Available VLAN Tags, as follows:
 
      
       
       	 [bookmark: pgfId-1558546]To add a VLAN tag object on the fly, which you can then add to the condition, click the add icon (
 
      
 
      [image: ] ) above the Available VLAN Tags list; see 
      Working with VLAN Tag Objects. 
     
 
      
       
       	 [bookmark: pgfId-1538970]To search for VLAN tag objects and groups to add, click the  Search by name or value prompt above the  Available VLAN Tags list, then type either the name of the object, or the value of a VLAN tag in the object. The list updates as you type to display matching objects.
 
       	 [bookmark: pgfId-1538971]To select an object, click it. To select multiple objects, use the Shift and Ctrl keys, or right-click and then select  Select All .
 
      
 
     
 
     [bookmark: pgfId-1538972]Step 4 Click Add to Rule or drag and drop to add the selected objects to the Selected VLAN Tags list. 
 
     [bookmark: pgfId-1538974]Step 5 Add any VLAN tags that you want to specify manually.
 
     [bookmark: pgfId-1538975]Click the Enter a VLAN tag prompt below the Selected VLAN Tags list; then type a VLAN tag or range and click Add. You can specify any VLAN tag from 1 to 4094; use a hyphen to specify a range of VLAN tags.
 
     [bookmark: pgfId-1538976]Step 6 Save or continue editing the rule.
 
     [bookmark: pgfId-1538958]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy on page 369.
 
     [bookmark: pgfId-1548382]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1547542][bookmark: 31649]Managing Network Analysis Rules
 
     [bookmark: pgfId-1548409]License: Any
 
     [bookmark: pgfId-1558584]A network analysis rule is simply a set of configurations and conditions that specifies how you preprocess traffic that matches those qualifications. You create and edit network analysis rules in the advanced options in an existing access control policy. Each rule belongs to only one policy.
 
     [bookmark: pgfId-1558822]To edit a custom network analysis rule:
 
     [bookmark: pgfId-1558826]Access: Admin/Access Admin/Network Admin
 
     
 ) next to the Intrusion and Network Analysis Policies section. 
     
 
     [bookmark: pgfId-1558831]The Network and Analysis Policies dialog box appears. If you have not added any custom network analysis rules, the web interface indicates that you have No Custom Rules; otherwise, it displays how many you have configured.
 
     [bookmark: pgfId-1558832]Step 2 Next to Network Analysis Rules, click the statement that indicates how many custom rules you have.
 
     [bookmark: pgfId-1558833]The dialog box expands to show the custom rules, if any.
 
     [bookmark: pgfId-1558890]Step 3 Edit your custom rules. You have the following options:
 
      
       
       	 [bookmark: pgfId-1558990]To edit a rule’s conditions, or change the network analysis policy invoked by the rule, click the edit icon (
 
      
 
      [image: ] ) next to the rule. 
     
 
      
       
       	 [bookmark: pgfId-1561020]To change a rule’s order of evaluation, click and drag the rule to the correct location. To select multiple rules, use the Shift and Ctrl keys.
 
       	 [bookmark: pgfId-1561017]To delete a rule, click the delete icon (
 
      
 
      [image: ] ) next to the rule. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1561182]Tip Right-clicking a rule displays a context menu that allows you to cut, copy, paste, edit, and add new network analysis rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1561512]Step 4 Click OK to save your changes.
 
     [bookmark: pgfId-1561513]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1561540]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533224]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1577264][bookmark: 72967]Getting Started with Network Analysis Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1577258]Network analysis policies govern many traffic preprocessing options, and are invoked by advanced settings in your access control policy. Network analysis-related preprocessing occurs after Security Intelligence blacklisting and SSL decryption, but before intrusion or file inspection begins.
 
    [bookmark: pgfId-1577248]By default, the system uses the Balanced Security and Connectivity network analysis policy to preprocess all traffic handled by an access control policy. However, you can choose a different default network analysis policy to perform this preprocessing. For your convenience, the system provides a choice of several non-modifiable network analysis policies, which are tuned for a specific balance of security and connectivity by the Cisco Vulnerability Research Team (VRT). You can also replace this default policy with a custom network analysis policy with custom preprocessing settings.
 
     
      
    
 
    
 
    [bookmark: pgfId-1577229]Tip System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules. Understanding Network Analysis and Intrusion Policies provides an overview of how network analysis and intrusion policies work together to examine your traffic, as well as some basics on using the navigation panel, resolving conflicts, and committing changes.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1577191]You can also tailor traffic preprocessing options to specific security zones, networks, and VLANs by creating multiple custom network analysis policies, then assigning them to preprocess different traffic. (Note that ASA FirePOWER devices cannot restrict preprocessing by VLAN.)
 
     
      
    
 
    
 
    [bookmark: pgfId-1578683]Note Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. The system does not coordinate the policies for you. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1589200]This chapter explains how to create a simple custom network analysis policy. This chapter also contains basic information on managing network analysis policies: editing, comparing, and so on. For more information, see:
 
     
     	 [bookmark: pgfId-1540876]Creating a Custom Network Analysis Policy
 
     	 [bookmark: pgfId-1550931]Managing Network Analysis Policies
 
     	 [bookmark: pgfId-1556675]Allowing Preprocessors to Affect Traffic in Inline Deployments
 
     	 [bookmark: pgfId-1556679]Generating a Report of Current Network Analysis Settings
 
     	 [bookmark: pgfId-1556683]Comparing Two Network Analysis Policies or Revisions
 
    
 
   
 
    
     [bookmark: pgfId-1577154][bookmark: 47884]Creating a Custom Network Analysis Policy
 
    [bookmark: pgfId-1577158]License: Protection
 
    [bookmark: pgfId-1577144]When you create a new network analysis policy you must give it a unique name, specify a base policy, and choose an inline mode.
 
    [bookmark: pgfId-1585080]The base policy defines the network analysis policy’s default settings. Modifying a setting in the new policy overrides—but does not change—the settings in the base policy. You can use either a system-provided or custom policy as your base policy. For more information, see Understanding the Base Layer.
 
    [bookmark: pgfId-1577119]The network analysis policy’s inline mode allows preprocessors to modify (normalize) and drop traffic to minimize the chances of attackers evading detection. Note that in passive deployments, the system cannot affect traffic flow regardless of the inline mode. For more information, see Allowing Preprocessors to Affect Traffic in Inline Deployments.
 
    [bookmark: pgfId-1577107]To create a network analysis policy:
 
    [bookmark: pgfId-1577111]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1594631]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1595035]The Network Analysis Policy page appears. 
 
    [bookmark: pgfId-1595097]You can create and edit network analysis as well as intrusion policies if your FireSIGHT System user account’s role is restricted to Intrusion Policy or Modify Intrusion Policy. To access the Network Analysis Policy page, select Policies > Intrusion, then click Network Analysis Policy. For more information, see Managing Custom User Roles.
 
    [bookmark: pgfId-1594633]Step 2 Click Create Policy.
 
    [bookmark: pgfId-1582005]If you have unsaved changes in another policy, click Cancel when prompted to return to the Network Analysis Policy page. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1577066]The Create Network Analysis Policy pop-up window appears.
 
    [bookmark: pgfId-1577067]Step 3 Give the policy a unique Name and, optionally, a Description.
 
    [bookmark: pgfId-1533958]Step 4 Specify the initial Base Policy.
 
    [bookmark: pgfId-1534432]You can use either a system-provided or custom policy as your base policy.
 
    [bookmark: pgfId-1587770]Step 5 Specify whether you want to allow preprocessors to affect traffic in an inline deployment:
 
     
      
      	 [bookmark: pgfId-1587771]To allow preprocessors to affect traffic, enable  Inline Mode .
 
      	 [bookmark: pgfId-1587772]To prevent preprocessors from affecting traffic, disable  Inline Mode .
 
     
 
    
 
    [bookmark: pgfId-1577058]Step 6 Create the policy:
 
     
      
      	 [bookmark: pgfId-1577059]Click  Create Policy to create the new policy and return to the Network Analysis Policy page. The new policy has the same settings as its base policy.
 
      	 [bookmark: pgfId-1577051]Click  Create and Edit Policy to create the policy and open it for editing in the advanced network analysis policy editor; see Editing Network Analysis Policies.
 
     
 
    
 
    [bookmark: pgfId-1577055]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1577043][bookmark: 13111]Managing Network Analysis Pol[bookmark: marker-1577042]icies
 
    [bookmark: pgfId-1577047]License: Protection
 
    [bookmark: pgfId-1589491]On the Network Analysis Policy page (Policies > Access Control, then click Network Analysis Policy) you can view your current custom network analysis policies, along with the following information:
 
     
     	 [bookmark: pgfId-1577023]the time and date the policy was last modified (in local time) and the user who modified it
 
     	 [bookmark: pgfId-1577017]whether the  Inline Mode setting is enabled, which allows preprocessors to affect traffic
 
     	 [bookmark: pgfId-1577018]which access control policies and devices are using the network analysis policy to preprocess traffic
 
     	 [bookmark: pgfId-1594853]whether a policy has unsaved changes, as well as information about who (if anyone) is currently editing the policy
 
    
 
    [bookmark: pgfId-1594854]In addition to custom policies that you create, the system provides two custom policies: Initial Inline Policy and Initial Passive Policy. These two network analysis policies use the Balanced Security and Connectivity network analysis policy as their base. The only difference between them is their inline mode, which allows preprocessors to affect traffic in the inline policy and disables it in the passive policy. You can edit and use these system-provided custom policies.
 
    [bookmark: pgfId-1592716]Options on the Network Analysis Policy page allow you to take the actions in the following table.
 
    [bookmark: pgfId-1594985]
 
     
     
 
     
 
      
       
       [bookmark: pgfId-1594923]Table 26-1 [bookmark: 22107]Network Analysis Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1594929]To... 
         
  
        	 
          
          [bookmark: pgfId-1594931]You can... 
         
  
        	 
          
          [bookmark: pgfId-1594933]See... 
         
  
       
 
        
        	[bookmark: pgfId-1594935]create a new network analysis policy
  
        	[bookmark: pgfId-1594937]click Create Policy.
  
        	[bookmark: pgfId-1594941]Creating a Custom Network Analysis Policy.
  
       
 
        
        	[bookmark: pgfId-1594944]edit an existing network analysis policy
  ). 
        	[bookmark: pgfId-1594953]Editing Network Analysis Policies.
  
       
 
        
        	[bookmark: pgfId-1594956]view a PDF report that lists the current configuration settings in a network analysis policy
  ). 
        	[bookmark: pgfId-1594965]Generating a Report of Current Network Analysis Settings
  
       
 
        
        	[bookmark: pgfId-1594968]compare the settings of two network analysis policies or two revisions of the same policy
  
        	[bookmark: pgfId-1594970]click Compare Policies.
  
        	[bookmark: pgfId-1594974]Comparing Two Network Analysis Policies or Revisions.
  
       
 
        
        	[bookmark: pgfId-1594977]delete a network analysis policy
  
        	 ), then confirm that you want to delete the policy. You cannot delete a network analysis policy if an access control policy references it.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1595151]Note that you can create and edit network analysis as well as intrusion policies if your FireSIGHT System user account’s role is restricted to Intrusion Policy or Modify Intrusion Policy. To access the Network Analysis Policy page, select Policies > Intrusion, then click Network Analysis Policy. For more information, see Managing Custom User Roles.
 
   
 
    
     [bookmark: pgfId-1594995][bookmark: 64212]Editing Network Analysis Policies
 
    [bookmark: pgfId-1594999]License: Protection
 
     
      
       
       [bookmark: pgfId-1591027]Table 26-2 [bookmark: 35642]Network Analysis Policy Editing Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1591033]To... 
         
  
        	 
          
          [bookmark: pgfId-1591035]You can... 
         
  
        	 
          
          [bookmark: pgfId-1591037]See... 
         
  
       
 
        
        	[bookmark: pgfId-1591039]allow preprocessors to modify or drop traffic
  
        	[bookmark: pgfId-1591041]select the Inline Mode check box on the Policy Information page.
  
        	[bookmark: pgfId-1591045]Allowing Preprocessors to Affect Traffic in Inline Deployments
  
       
 
        
        	[bookmark: pgfId-1591048]change the base policy
  
        	[bookmark: pgfId-1591050]select a base policy from the Base Policy drop-down list on the Policy Information page.
  
        	[bookmark: pgfId-1591055]Changing the Base Policy
  
       
 
        
        	[bookmark: pgfId-1591057]view the settings in the base policy
  
        	[bookmark: pgfId-1591059]click Manage Base Policy on the Policy Information page.
  
        	[bookmark: pgfId-1591063]Understanding the Base Layer
  
       
 
        
        	[bookmark: pgfId-1591066]enable, disable, or edit the settings for a preprocessor
  
        	[bookmark: pgfId-1591068]click Settings in the navigation panel.
  
        	[bookmark: pgfId-1591072]Configuring Preprocessors in a Network Analysis Policy
  
       
 
        
        	[bookmark: pgfId-1591075]manage policy layers
  
        	[bookmark: pgfId-1591077]click Policy Layers in the navigation panel.
  
        	[bookmark: pgfId-1591081]Using Layers in a Network Analysis or Intrusion Policy
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1591084]When tailoring a network analysis policy, especially when disabling preprocessors, keep in mind that some preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1591085]Note Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1591089]The system caches one network analysis policy per user. While editing a network analysis policy, if you select any menu or other path to another page, your changes stay in the system cache even if you leave the page. In addition to the actions you can perform in the table above, Understanding Network Analysis and Intrusion Policies provides information on using the navigation panel, resolving conflicts, and committing changes.
 
    [bookmark: pgfId-1576768]To edit a network analysis policy:
 
    [bookmark: pgfId-1576772]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1589678]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1576761]The Network Analysis Policy page appears.
 ) next to the network analysis policy you want to configure. 
    
 
    [bookmark: pgfId-1576745]The network analysis policy editor appears, focused on the Policy Information page and with a navigation panel on the left.
 
    [bookmark: pgfId-1566984]Step 3 Edit your policy. Take any of the actions summarized above. 
 
    [bookmark: pgfId-1566985]Step 4 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
    [bookmark: pgfId-1576730]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1577607][bookmark: 93417]Allowing Preprocessors to Affect Traffic in Inline Deployments
 
     [bookmark: pgfId-1596916]License: Protection
 
     [bookmark: pgfId-1596918]In an inline deployment, some preprocessors can modify and block traffic. For example:
 
      
      	 [bookmark: pgfId-1596919]The inline normalization preprocessor normalizes packets to prepare them for analysis by other preprocessors and the intrusion rules engine. You can also use the preprocessor’s  Allow These TCP Options and  Block Unrecoverable TCP Header Anomalies options to block certain packets. For more information, see Normalizing Inline Traffic.
 
      	 [bookmark: pgfId-1580814]The system can drop packets with invalid checksums; see Verifying Checksums.
 
      	 [bookmark: pgfId-1580815]The system can drop packets matching rate-based attack prevention settings; see Preventing Rate-Based Attacks.
 
     
 
     [bookmark: pgfId-1588290]For a preprocessor configured in the network analysis policy to affect traffic, you must enable and correctly configure the preprocessor, as well as correctly deploy managed devices inline, that is, with inline interface sets. Finally, you must enable the network analysis policy’s Inline Mode setting.
 
     [bookmark: pgfId-1598154]If you want to assess how your configuration would function in an inline deployment without actually modifying traffic, you can disable inline mode. In passive deployments or inline deployments in tap mode, the system cannot affect traffic regardless of the inline mode.
 
     [bookmark: pgfId-1597191]Note that disabling inline mode can affect intrusion event performance statistics graphs. With inline mode enabled in an inline deployment, the Intrusion Event Performance page (Overview > Summary > Intrusion Event Performance) displays graphs that represent normalized and blocked packets. If you disable inline mode, or in a passive deployment, many of the graphs display data about the traffic the system would have normalized or dropped. For more information, see Generating Intrusion Event Performance Statistics Graphs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1588295]Tip In an inline deployment, Cisco recommends that you enable inline mode and configure the inline normalization preprocessor with the Normalize TCP Payload option enabled. In a passive deployment,Cisco recommends you configure adaptive profiles. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1577632]To allow preprocessors to affect traffic in an inline deployment:
 
     [bookmark: pgfId-1577636]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1589694]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1577638]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1577643]The Policy Information page appears.
 
     [bookmark: pgfId-1577644]Step 3 Specify whether you want to allow preprocessors to affect traffic:
 
      
       
       	 [bookmark: pgfId-1577645]To allow preprocessors to affect traffic, enable  Inline Mode .
 
       	 [bookmark: pgfId-1588428]To prevent preprocessors from affecting traffic, disable  Inline Mode .
 
      
 
     
 
     [bookmark: pgfId-1588430]Step 4 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1577651]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1576733][bookmark: 13049]Configuring Preprocessors in a Network Analysis Policy
 
     [bookmark: pgfId-1576737]License: Protection
 
      
      [bookmark: pgfId-1588597] 
       Preprocessors prepare traffic to be further inspected by normalizing traffic and identifying protocol anomalies. Preprocessors can generate preprocessor events (see 
      Reading Preprocessor Events) when packets trigger preprocessor options that you configure. The base policy for your network analysis policy determines which preprocessors are enabled by default and the default configuration for each. 
     
 
     [bookmark: pgfId-1576719]When you select Settings in the navigation panel of a network analysis policy, the policy lists its preprocessors by type. On the Settings page, you can enable or disable preprocessors in your network analysis policy, as well as access preprocessor configuration pages.
 
     [bookmark: pgfId-1576705]A preprocessor must be enabled for you to configure it. When you enable a preprocessor, a sublink to the configuration page for the preprocessor appears beneath the Settings link in the navigation panel, and an Edit link to the configuration page appears next to the preprocessor on the Settings page. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1584831]Tip To revert a preprocessor’s configuration to the settings in the base policy, click Revert to Defaults on a preprocessor configuration page. When prompted, confirm that you want to revert.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1584781]When you disable a preprocessor, the sublink and Edit link no longer appear, but your configurations are retained. Note that to perform their particular analysis, many preprocessors and intrusion rules require that traffic first be decoded or preprocessed in a certain way. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.
 
      
       
     
 
     
 
     [bookmark: pgfId-1587242]Note In most cases, preprocessors require specific expertise to configure and typically require little or no modification. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. For more information, see Limitations of Custom Policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1587246]Modifying a preprocessor configuration requires an understanding of the configuration and its potential impact on your network. The following sections provide links to specific configuration details for each preprocessor.
 
     [bookmark: pgfId-1570154]Application Layer Preprocessors 
 
      
       
        
        [bookmark: pgfId-1570161]Table 26-3 Application Layer Preprocessor Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1570165]For information on... 
          
  
         	 
           
           [bookmark: pgfId-1570167]See... 
          
  
        
 
         
         	[bookmark: pgfId-1570169]DCE/RPC Configuration
  
         	[bookmark: pgfId-1570174]Decoding DCE/RPC Traffic
  
        
 
         
         	[bookmark: pgfId-1570176]DNS Configuration
  
         	[bookmark: pgfId-1570181]Detecting Exploits in DNS Name Server Responses
  
        
 
         
         	[bookmark: pgfId-1570183]FTP and Telnet Configuration
  
         	[bookmark: pgfId-1570188]Decoding FTP and Telnet Traffic
  
        
 
         
         	[bookmark: pgfId-1570190]HTTP Configuration
  
         	[bookmark: pgfId-1572998]Decoding HTTP Traffic
  
        
 
         
         	[bookmark: pgfId-1570197]Sun RPC Configuration
  
         	[bookmark: pgfId-1573003]Using the Sun RPC Preprocessor
  
        
 
         
         	[bookmark: pgfId-1570204]SIP Configuration
  
         	[bookmark: pgfId-1573008]Decoding the Session Initiation Protocol
  
        
 
         
         	[bookmark: pgfId-1570211]GTP Command Channel Configuration
  
         	[bookmark: pgfId-1573013]Configuring the GTP Command Channel
  
        
 
         
         	[bookmark: pgfId-1570218]IMAP Configuration
  
         	[bookmark: pgfId-1573018]Decoding IMAP Traffic
  
        
 
         
         	[bookmark: pgfId-1570225]POP Configuration
  
         	[bookmark: pgfId-1573023]Decoding POP Traffic
  
        
 
         
         	[bookmark: pgfId-1570232]SMTP Configuration
  
         	[bookmark: pgfId-1573028]Decoding SMTP Traffic
  
        
 
         
         	[bookmark: pgfId-1570239]SSH Configuration
  
         	[bookmark: pgfId-1573033]Detecting Exploits Using the SSH Preprocessor
  
        
 
         
         	[bookmark: pgfId-1570246]SSL Configuration
  
         	[bookmark: pgfId-1573038]Using the SSL Preprocessor
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1570636]SCADA Preprocessors
 
      
       
        
        [bookmark: pgfId-1570643]Table 26-4 SCADA Preprocessor Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1570647]For information on... 
          
  
         	 
           
           [bookmark: pgfId-1570649]See... 
          
  
        
 
         
         	[bookmark: pgfId-1570651]Modbus Configuration
  
         	[bookmark: pgfId-1570655]Configuring the Modbus Preprocessor
  
        
 
         
         	[bookmark: pgfId-1570658]DNP3 Configuration
  
         	[bookmark: pgfId-1570663]Configuring the DNP3 Preprocessor
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1565910]Transport/Network Layer Preprocessors
 
      
       
        
        [bookmark: pgfId-1570765]Table 26-5 Transport and Network Layer Preprocessor Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1570769]For information on... 
          
  
         	 
           
           [bookmark: pgfId-1570771]See... 
          
  
        
 
         
         	[bookmark: pgfId-1570773]Checksum Verification
  
         	[bookmark: pgfId-1570778]Verifying Checksums
  
        
 
         
         	[bookmark: pgfId-1570787]Inline Normalization
  
         	[bookmark: pgfId-1570792]Normalizing Inline Traffic
  
        
 
         
         	[bookmark: pgfId-1570794]IP Defragmentation
  
         	[bookmark: pgfId-1570799]Defragmenting IP Packets
  
        
 
         
         	[bookmark: pgfId-1570801]Packet Decoding
  
         	[bookmark: pgfId-1570806]Understanding Packet Decoding
  
        
 
         
         	[bookmark: pgfId-1570808]TCP Stream Configuration
  
         	[bookmark: pgfId-1570813]Using TCP Stream Preprocessing
  
        
 
         
         	[bookmark: pgfId-1570815]UDP Stream Configuration
  
         	[bookmark: pgfId-1570820]Using UDP Stream Preprocessing
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1576638]Note that some advanced transport and network preprocessor settings apply globally to all networks, zones, and VLANs where you apply your access control policy. You configure these advanced settings in an access control policy rather than in a network analysis policy; see Configuring Advanced Transport/Network Settings.
 
     [bookmark: pgfId-1565940]Specific Threat Detection
 
      
       
        
        [bookmark: pgfId-1571383]Table 26-6 Specific Threat Detection Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1571387]For information on... 
          
  
         	 
           
           [bookmark: pgfId-1571389]See... 
          
  
        
 
         
         	[bookmark: pgfId-1571391]Back Orifice Detection
  
         	[bookmark: pgfId-1571396]Detecting Back Orifice
  
        
 
         
         	[bookmark: pgfId-1571398]Portscan Detection
  
         	[bookmark: pgfId-1571403]Detecting Portscans
  
        
 
         
         	[bookmark: pgfId-1571405]Rate-Based Attack Prevention
  
         	[bookmark: pgfId-1571410]Preventing Rate-Based Attacks
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1565954]Note that you configure the sensitive data preprocessor, which detects sensitive data such as credit card numbers and Social Security numbers in ASCII text, in intrusion policies. For more information, see Detecting Sensitive Data.
 
    
 
   
 
    
     [bookmark: pgfId-1576581][bookmark: 83426]Generating a Report of Current Network Analysis Settings
 
    [bookmark: pgfId-1576585]License: Protection
 
    [bookmark: pgfId-1576574]A network analysis policy report is a record of the policy configuration at a specific point in time. The system combines the settings in the base policy with the settings of the policy layers, and makes no distinction between which settings originated in the base policy or policy layer.
 
     
      
       
       [bookmark: pgfId-1576541]Table 26-7 [bookmark: 84936]Network Analysis Policy Report Sections 
 
       
       
        
        	 
          
          [bookmark: pgfId-1576545]Section 
         
  
        	 
          
          [bookmark: pgfId-1576547]Description 
         
  
       
 
        
        	[bookmark: pgfId-1576549]Policy Information
  
        	[bookmark: pgfId-1576551]Provides the name and description of the policy, the name of the user who last modified the policy, and the date and time the policy was last modified. Also indicates whether inline normalization can be enabled, the current rule update version, and whether the base policy is locked to the current rule update.
  
       
 
        
        	[bookmark: pgfId-1576553]Settings
  
        	[bookmark: pgfId-1576555]Lists all enabled preprocessor settings and their configurations.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1576557]You can also generate a comparison report that compares two network analysis policies, or two revisions of the same policy. For more information, see Comparing Two Network Analysis Policies or Revisions.
 
    [bookmark: pgfId-1576528]To view a network analysis policy report:
 
    [bookmark: pgfId-1576532]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1589706]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1576521]The Network Analysis Policy page appears.
 ) next to the policy for which you want to generate a report. Remember to commit any changes before you generate a network analysis policy report; only committed changes appear in the report. 
    
 
    [bookmark: pgfId-1545808]The system generates the report. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
    [bookmark: pgfId-1576494]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1576498][bookmark: 48726]Comparing Two Network Analysis Policies or Revi[bookmark: marker-1576497]sions
 
    [bookmark: pgfId-1546181]License: Protection
 
    [bookmark: pgfId-1576491]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between two network analysis policies. You can compare any two network analysis policies or two revisions of the same network analysis policy. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies or policy revisions.
 
    [bookmark: pgfId-1576481]There are two tools you can use to compare network analysis policies or policy revisions:
 
     
     	 [bookmark: pgfId-1576482]The comparison view displays only the differences between two network analysis policies or network analysis policy revisions in a side-by-side format; the name of each policy or policy revision appears in the title bar on the left and right sides of the comparison view.
 
    
 
    [bookmark: pgfId-1576469]You can use this to view and navigate both policy revisions on the web interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-1576470]The comparison report creates a record of only the differences between two network analysis policies or network analysis policy revisions in a format similar to the network analysis policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-1572698]You can use this to save, copy, print and share your policy comparisons for further examination.
 
    [bookmark: pgfId-1546189]For more information on understanding and using the policy comparison tools, see:
 
     
     	 [bookmark: pgfId-1546193]Using the Network Analysis Policy Comparison View
 
     	 [bookmark: pgfId-1576454]Using the Network Analysis Policy Comparison Report
 
    
 
     
      [bookmark: pgfId-1576456][bookmark: 29486]Using the Network Analysis Policy Comparison View
 
     [bookmark: pgfId-1576460]License: Protection
 
     [bookmark: pgfId-1546204]The comparison view displays both policies or policy revisions in a side-by-side format, with each policy or policy revision identified by name in the title bar on the left and right sides of the comparison view. The time of last modification and the last user to modify are displayed with the policy name.
 
     [bookmark: pgfId-1546205]Differences between the two policies are highlighted:
 
      
      	 [bookmark: pgfId-1546206]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-1546207]Green indicates that the highlighted setting appears in one policy but not the other.
 
     
 
     [bookmark: pgfId-1546208]You can perform any of the actions in the following table.
 
     [bookmark: pgfId-1576436]
 
      
      
 
      [bookmark: pgfId-1576422]The window displays the name of the layer that contains the preprocessor configuration.
 
       
        
        [bookmark: pgfId-1576400]Table 26-8 [bookmark: 91381]Network Analysis Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1576404]To... 
          
  
         	 
           
           [bookmark: pgfId-1576406]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1576408]navigate individually through changes
  
         	[bookmark: pgfId-1576410]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-1576416]determine which layer contains the configuration for a specific preprocessor
  ) next to the configuration you want to view. 
        
 
         
         	[bookmark: pgfId-1576424]generate a new policy comparison view
  
         	[bookmark: pgfId-1576426]click New Comparison.
 [bookmark: pgfId-1576429]The Select Comparison window appears. See Using the Network Analysis Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-1576432]generate a policy comparison report
  
         	[bookmark: pgfId-1576434]click Comparison Report. 
 [bookmark: pgfId-1576435]The policy comparison report creates a PDF document that lists only the differences between the two policies or policy revisions.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1576440][bookmark: 14990]Using the Network Analysis Policy Comp[bookmark: marker-1576439]arison Report
 
     [bookmark: pgfId-1576390]License: Protection
 
     [bookmark: pgfId-1576391]A network analysis policy comparison report is a record of all differences between two network analysis policies or two revisions of the same network analysis policy identified by the network analysis policy comparison view, presented as a PDF. You can use this report to further examine the differences between two network analysis policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-1576371]You can generate a network analysis policy comparison report from the comparison view for any policies to which you have access. Remember to save any changes before you generate a policy report; only saved changes appear in the report.
 
     [bookmark: pgfId-1576360]The format of the policy comparison report is the same as the policy report with one exception: the policy report contains all configurations in the policy, and the policy comparison report lists only those configurations that differ between the policies. A network analysis policy comparison report contains the sections described in Table 26-7. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1576352]Tip You can use a similar procedure to compare SSL, access control, intrusion, file, system, or health policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1576353]To compare two network analysis policies or policy revisions:
 
     [bookmark: pgfId-1576357]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1589730]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1576349]The Network Analysis Policy page appears.
 
     [bookmark: pgfId-1576341]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-1546266]The Select Comparison window appears.
 
     [bookmark: pgfId-1546267]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-1546268]To compare two different policies, select  Other Policy .
 
      
 
     
 
     [bookmark: pgfId-1546269]The page refreshes and the Policy A and Policy B drop-down lists appear.
 
      
       
       	 [bookmark: pgfId-1546270]To compare two revisions of the same policy, select  Other Revision. 
 
      
 
     
 
     [bookmark: pgfId-1546271]The page refreshes and the Policy, Revision A, and Revision B drop-down lists appear.
 
     [bookmark: pgfId-1546272]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-1546742]If you are comparing two different policies, select the policies you want to compare from the Policy A and Policy B drop-down lists.
 
       	 [bookmark: pgfId-1546743]If you are comparing two revision of the same policy, select the Policy, then select the timestamped revisions you want to compare from the Revision A and Revision B drop-down lists.
 
      
 
     
 
     [bookmark: pgfId-1546275]Step 5 Click OK to display the policy comparison view.
 
     [bookmark: pgfId-1576334]The comparison view appears.
 
     [bookmark: pgfId-1576335]Step 6 Optionally, click Comparison Report to generate the network analysis policy comparison report. 
 
     [bookmark: pgfId-1576336]The network analysis policy comparison report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
     [bookmark: pgfId-1546279]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1600148][bookmark: 20122]Using Applic[bookmark: marker-1600147]ation Layer Preprocessors 
      
      
 
     
 
 
    [bookmark: pgfId-1600149]You configure application layer preprocessors in a network analysis policy, which prepares traffic for inspection using the rules enabled in an intrusion policy. See Understanding Network Analysis and Intrusion Policies for more information.
 
    [bookmark: pgfId-1598241]Application-layer protocols can represent the same data in a variety of ways. Cisco provides application layer protocol decoders that normalize specific types of packet data into formats that the intrusion rules engine can analyze. Normalizing application-layer protocol encodings allows the rules engine to effectively apply the same content-related rules to packets whose data is represented differently and obtain meaningful results.
 
    [bookmark: pgfId-1624084]When an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s web interface. For more information, see Limitations of Custom Policies.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1626205] 
     Caution Some users with custom user roles cannot access the network analysis policy via the standard menu path ( 
     Policies > Access Control > Network Analysis Policy). These users can access the network analysis policy through the intrusion policy: 
     Policies > Intrusion > Intrusion Policy > Network Analysis Policy. For more information on custom user roles, see 
     Managing Custom User Roles. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1531613]Note that preprocessors do not generate events in most cases unless you enable the accompanying preprocessor rules in an intrusion policy. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531617]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531621]Decoding DCE/RPC Traffic describes the DCE/RPC preprocessor and explains how to configure it to prevent evasion attempts and detect anomalies in DCE/RPC traffic.
 
     	 [bookmark: pgfId-1531625]Detecting Exploits in DNS Name Server Responses describes the DNS preprocessor and explains how to configure it to detect any of three specific exploits in DNS name server responses.
 
     	 [bookmark: pgfId-1531629]Decoding FTP and Telnet Traffic describes the FTP/Telnet decoder and explains how to configure it to normalize and decode FTP and Telnet traffic.
 
     	 [bookmark: pgfId-1531633]Decoding HTTP Traffic describes the HTTP decoder and explains how to configure it to normalize HTTP traffic.
 
     	 [bookmark: pgfId-1531637]Using the Sun RPC Preprocessor describes the RPC decoder and explains how to configure it to normalize RPC traffic.
 
     	 [bookmark: pgfId-1531641]Decoding the Session Initiation Protocol explains how you can use the SIP preprocessor to decode and detect anomalies in SIP traffic. 
 
     	 [bookmark: pgfId-1531645]Configuring the GTP Command Channel explains how you can use the GTP preprocessor to provide the rules engine with GTP command channel messages extracted by the packet decoder.
 
     	 [bookmark: pgfId-1531649]Decoding IMAP Traffic explains how you can use the IMAP preprocessor to decode and detect anomalies in IMAP traffic.
 
     	 [bookmark: pgfId-1531653]Decoding POP Traffic explains how you can use the POP preprocessor to decode and detect anomalies in POP traffic.
 
     	 [bookmark: pgfId-1531657]Decoding SMTP Traffic describes the SMTP decoder and explains how to configure it to decode and normalize SMTP traffic.
 
     	 [bookmark: pgfId-1531661]Detecting Exploits Using the SSH Preprocessor explains how to identify and process exploits in SSH-encrypted traffic.
 
     	 [bookmark: pgfId-1531665]Using the SSL Preprocessor explains how you can use the SSL preprocessor to identify encrypted traffic and eliminate false positives by stopping inspection of that traffic. 
 
     	 [bookmark: pgfId-1531669]Configuring SCADA Preprocessing explains how you can use the Modbus and DNP3 preprocessors to detect anomalies in corresponding traffic and provide data to the intrusion rules engine for inspection of certain protocol fields.
 
    
 
   
 
    
     [bookmark: pgfId-1531674][bookmark: 18799]Dec[bookmark: DCERPC]odin[bookmark: marker-1531672]g DC[bookmark: marker-1531673]E/RPC Traffic
 
    [bookmark: pgfId-1531681]License: Protection
 
    [bookmark: pgfId-1531682]The DCE/RPC protocol allows processes on separate network hosts to communicate as if the processes were on the same host. These inter-process communications are commonly transported between hosts over TCP and UDP. Within the TCP transport, DCE/RPC might also be further encapsulated in the Windows Server Message Block (SMB) protocol or in Samba, an open-source SMB implementation used for inter-process communication in a mixed environment comprised of Windows and UNIX- or Linux-like operating systems. In addition, Windows IIS web servers on your network might use IIS RPC over HTTP, which provides distributed communication through a firewall, to proxy TCP-transported DCE/RPC traffic.
 
    [bookmark: pgfId-1531683]Note that descriptions of DCE/RPC preprocessor options and functionality include the Microsoft implementation of DCE/RPC known as MSRPC; descriptions of SMB options and functionality refer to both SMB and Samba.
 
    [bookmark: pgfId-1531684]Although most DCE/RPC exploits occur in DCE/RPC client requests targeted for DCE/RPC servers, which could be practically any host on your network that is running Windows or Samba, exploits can also occur in server responses. The DCE/RPC preprocessor detects DCE/RPC requests and responses encapsulated in TCP, UDP, and SMB transports, including TCP-transported DCE/RPC using version 1 RPC over HTTP. The preprocessor analyzes DCE/RPC data streams and detects anomalous behavior and evasion techniques in DCE/RPC traffic. It also analyzes SMB data streams and detects anomalous SMB behavior and evasion techniques.
 
    [bookmark: pgfId-1531685]The DCE/RPC preprocessor also desegments SMB and defragments DCE/RPC in addition to the IP defragmentation provided by the IP defragmentation preprocessor and the TCP stream reassembly provided by the TCP stream preprocessor. See Using TCP Stream Preprocessing and Defragmenting IP Packets.
 
    [bookmark: pgfId-1531692]Finally, the DCE/RPC preprocessor normalizes DCE/RPC traffic for processing by the rules engine. See DCE/RPC Keywords for information on using specific DCE/RPC rule keywords to detect DCE/RPC services, operations, and stub data.
 
    [bookmark: pgfId-1531696]You configure the DCE/RPC preprocessor by modifying any of the global options that control how the preprocessor functions, and by specifying one or more target-based server policies that identify the DCE/RPC servers on your network by IP address and by either the Windows or Samba version running on them.
 
    [bookmark: pgfId-1531697]You must enable DCE/RPC preprocessor rules, which have a generator ID (GID) of 132 or 133, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531711]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531715]Selecting Global DCE/RPC Options
 
     	 [bookmark: pgfId-1531719]Understanding Target-Based DCE/RPC Server Policies
 
     	 [bookmark: pgfId-1531723]Understanding DCE/RPC Transports
 
     	 [bookmark: pgfId-1531727]Selecting DCE/RPC Target-Based Policy Options
 
     	 [bookmark: pgfId-1531731]Configuring the DCE/RPC Preprocessor
 
    
 
     
      [bookmark: pgfId-1531734][bookmark: 21864]Selectin[bookmark: marker-1531733]g Global DCE/RPC Options
 
     [bookmark: pgfId-1531741]License: Protection
 
     [bookmark: pgfId-1531742]Global DCE/RPC preprocessor options control how the preprocessor functions. Except for the Memory Cap Reached option, modifying these options could have a negative impact on performance or detection capability. You should not modify them unless you have a thorough understanding of the preprocessor and the interaction between the preprocessor and enabled DCE/RPC rules. In particular, make sure that the Maximum Fragment Size option and Reassembly Threshold option are greater than or equal to the depth to which the rules need to detect. For more information, see Constraining Content Matches and Using Byte_Jump and Byte_Test.
 
     [bookmark: pgfId-1531749]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1531751]Max[bookmark: marker-1531750]imum Fragment Size
 
     [bookmark: pgfId-1531752]When Enable Defragmentation is selected, specifies the maximum DCE/RPC fragment length allowed from 1514 to 65535 bytes. The preprocessor truncates larger fragments for processing purposes to the specified size before defragmenting but does not alter the actual packet. A blank field disables this option.
 
     [bookmark: pgfId-1531754]Reas[bookmark: marker-1531753]sembly Threshold
 
     [bookmark: pgfId-1531755]When Enable Defragmentation is selected, 0 disables this option, or 1 to 65535 bytes specifies a minimum number of fragmented DCE/RPC bytes and, if applicable, segmented SMB bytes to queue before sending a reassembled packet to the rules engine. A low value increases the likelihood of early detection but could have a negative impact on performance. You should test for performance impact if you enable this option.
 
     [bookmark: pgfId-1531757][bookmark: marker-1531756]Enable Defragmentation
 
     [bookmark: pgfId-1531758]Specifies whether to defragment fragmented DCE/RPC traffic. When disabled, the preprocessor still detects anomalies and sends DCE/RPC data to the rules engine, but at the risk of missing exploits in fragmented DCE/RPC data.
 
     [bookmark: pgfId-1531759]Although this option provides the flexibility of not defragmenting DCE/RPC traffic, most DCE/RPC exploits attempt to take advantage of fragmentation to hide the exploit. Disabling this option would bypass most known exploits, resulting in a large number of false negatives.
 
     [bookmark: pgfId-1531761][bookmark: marker-1531760]Memory Cap Reached
 
     [bookmark: pgfId-1531762]Detects when the maximum memory limit allocated to the preprocessor is reached or exceeded. When the maximum memory cap is reached or exceeded, the preprocessor frees all pending data associated with the session that caused the memory cap event and ignores the rest of that session.
 
     [bookmark: pgfId-1531766]You can enable rule 133:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531768][bookmark: 34134]Auto-Detect Policy on SMB Session
 
     [bookmark: pgfId-1531769]Detects the Windows or Samba version that is identified in SMB Session Setup AndX requests and responses. When the detected version is different from the Windows or Samba version configured for the Policy configuration option, the detected version overrides the configured version for that session only. See Understanding Target-Based DCE/RPC Server Policies for more information.
 
     [bookmark: pgfId-1531773]For example, if you set Policy to Windows XP and the preprocessor detects Windows Vista, the preprocessor uses a Windows Vista policy for that session. Other settings remain in effect. 
 
     [bookmark: pgfId-1531774]When the DCE/RPC transport is not SMB (that is, when the transport is TCP or UDP), the version cannot be detected and the policy cannot be automatically configured.
 
     [bookmark: pgfId-1531775]To enable this option, select one of the following from the drop-down list:
 
     [bookmark: pgfId-1531776] – Select Client to inspect server-to-client traffic for the policy type.
 
     [bookmark: pgfId-1531777] – Select Server to inspect client-to-server traffic for the policy type.
 
     [bookmark: pgfId-1531778] – Select Both to inspect server-to-client and client-to-server traffic for the policy type.
 
    
 
     
      [bookmark: pgfId-1531781][bookmark: 28081]Understanding[bookmark: marker-1531780] Target-Based DCE/RPC Server Policies
 
     [bookmark: pgfId-1531788]License: Protection
 
     [bookmark: pgfId-1531789]You can create one or more target-based server policies to configure the DCE/RPC preprocessor to inspect DCE/RPC traffic the same as a specified type of server would process it. Target-based policy configuration includes identifying the Windows or Samba version running on hosts you identify on your network, enabling transport protocols and specifying the ports carrying DCE/RPC traffic to those hosts, and setting other server-specific options.
 
     [bookmark: pgfId-1531790]Windows and Samba DCE/RPC implementations differ significantly. For example, all versions of Windows use the DCE/RPC context ID in the first fragment when defragmenting DCE/RPC traffic, and all versions of Samba use the context ID in the last fragment. As another example, Windows Vista uses the opnum (operation number) header field in the first fragment to identify a specific function call, and Samba and all other Windows versions use the opnum field in the last fragment.
 
     [bookmark: pgfId-1531791]There are also significant differences in Windows and Samba SMB implementations. For example, Windows recognizes the SMB OPEN and READ commands when working with named pipes, but Samba does not recognize these commands.
 
     [bookmark: pgfId-1531792]When you enable the DCE/RPC preprocessor, you automatically enable a default target-based policy. Optionally, you can add target-based policies that target other hosts running different Windows or Samba versions by selecting the correct version from the Policy drop-down list. The default target-based policy applies to any host not included in another target-based policy.
 
     [bookmark: pgfId-1531793]In each target-based policy, you can enable one or more transports and specify detection ports for each. You can also enable and specify auto-detection ports. See Understanding DCE/RPC Transports for more information.
 
     [bookmark: pgfId-1531797]You can also configure other target-based policy options. You can set the preprocessor to detect when there is an attempt to connect to one or more shared SMB resources that you identify. You can configure the preprocessor to detect files in SMB traffic, and to inspect a specified number of bytes in a detected file. You can also modify an advanced option that should be modified only by a user with SMB protocol expertise; this option lets you set the preprocessor to detect when a number of chained SMB AndX commands exceed a specified maximum number.
 
     [bookmark: pgfId-1531798]In each target-based policy, you can:
 
      
      	 [bookmark: pgfId-1531799]enable one or more transports and specify  detection ports  for each. 
 
      	 [bookmark: pgfId-1531803]enable and specify  auto-detection ports . See Understanding DCE/RPC Transports for more information.
 
      	 [bookmark: pgfId-1531804]set the preprocessor to detect when there is an attempt to connect to one or more shared SMB resources that you identify. 
 
      	 [bookmark: pgfId-1531805]configure the preprocessor to detect files in SMB traffic, and to inspect a specified number of bytes in a detected file. 
 
      	 [bookmark: pgfId-1531806]modify an advanced option that should be modified only by a user with SMB protocol expertise; this option lets you set the preprocessor to detect when a number of chained SMB AndX commands exceed a specified maximum number.
 
     
 
     [bookmark: pgfId-1531807]Note that you can enable the Auto-Detect Policy on SMB Session global option to automatically override the policy type configured for a targeted policy on a per session basis when SMB is the DCE/RPC transport. See Auto-Detect Policy on SMB Session.
 
     [bookmark: pgfId-1531811]In addition to enabling SMB traffic file detection in the DCE/RPC preprocessor, you can configure a file policy to optionally capture and block these files, or submit them to the Collective Security Intelligence Cloud for dynamic analysis. Within that policy, you must create a file rule with an Action of Detect Files or Block Files and a selected Application Protocol of Any or NetBIOS-ssn (SMB). See Creating a File Policy and Working with File Rules for more information.
 
    
 
     
      [bookmark: pgfId-1531823][bookmark: 30205]Understanding DCE/RPC Tra[bookmark: marker-1531822]nsports
 
     [bookmark: pgfId-1531830]License: Protection
 
     [bookmark: pgfId-1531831]In each target-based policy, you can enable one or more of the TCP, UDP, SMB, and RPC over HTTP transports. When you enable a transport, you must also specify one or more detection ports, that is, ports that are known to carry DCE/RPC traffic. Optionally, you can also enable and specify auto-detection ports, that is, ports that the preprocessor tests first to determine if they carry DCE/RPC traffic and continues processing only when it detects DCE/RPC traffic.
 
     [bookmark: pgfId-1531835]Cisco recommends that you use the default detection ports, which are either well-known ports or otherwise commonly-used ports for each protocol. You would add detection ports only if you detected DCE/RPC traffic on a non-default port.
 
     [bookmark: pgfId-1531836]When you enable auto-detection ports, ensure that they are set to the port range from 1024 to 65535 to cover the entire ephemeral port range. Note that it is unlikely that you would enable or specify auto-detection ports for the RPC over HTTP Proxy Auto-Detect Ports option or the SMB Auto-Detect Ports option because there is little likelihood that traffic for either would occur or even be possible except on the specified default detection ports. Note also that auto-detection occurs only for ports not already identified by transport detection ports. See Selecting DCE/RPC Target-Based Policy Options for recommendations for enabling or disabling auto-detection ports for each transport.
 
     [bookmark: pgfId-1531847]You can specify ports for one or more transports in any combination in a Windows target-based policy to match the traffic on your network, but you can only specify ports for the SMB transport in a Samba target-based policy.
 
     [bookmark: pgfId-1531848]Note that you must enable at least one DCE/RPC transport in the default target-based policy except when you have added a DCE/RPC target-based policy that has at least one transport enabled. For example, you might want to specify the hosts for all DCE/RPC implementations and not have the default target-based policy apply to unspecified hosts, in which case you would not enable a transport for the default target-based policy.
 
     [bookmark: pgfId-1531849]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1531853]Understanding Connectionless and Connection-Oriented DCE/RPC Traffic
 
      	 [bookmark: pgfId-1531857]Understanding the RPC over HTTP Transport
 
     
 
    
 
     
      [bookmark: pgfId-1531859][bookmark: 10993]Understanding Connectionless and Connection-Oriented DCE/RPC Traffic
 
     [bookmark: pgfId-1531866]License: Protection
 
     [bookmark: pgfId-1531867]DCE/RPC messages comply with one of two distinct DCE/RPC Protocol Data Unit (PDU) protocols:
 
      
      	 [bookmark: pgfId-1531868]the connection-oriented DCE/RPC PDU protocol
 
     
 
     [bookmark: pgfId-1531869]The DCE/RPC preprocessor detects connection-oriented DCE/RPC in the TCP, SMB, and RPC over HTTP transports.
 
      
      	 [bookmark: pgfId-1531870]the connectionless DCE/RPC PDU protocol
 
     
 
     [bookmark: pgfId-1531871]The DCE/RPC preprocessor detects connectionless DCE/RPC in the UDP transport.
 
     [bookmark: pgfId-1531872]The two DCE/RPC PDU protocols have their own unique headers and data characteristics. For example, the connection-oriented DCE/RPC header length is typically 24 bytes and the connectionless DCE/RPC header length is fixed at 80 bytes. Also, correct fragment order of fragmented connectionless DCE/RPC cannot be handled by a connectionless transport and, instead, must be ensured by connectionless DCE/RPC header values; in contrast, the transport protocol ensures correct fragment order for connection-oriented DCE/RPC. The DCE/RPC preprocessor uses these and other protocol-specific characteristics to monitor both protocols for anomalies and other evasion techniques, and to decode and defragment traffic before passing it to the rules engine.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531882]Note the following in the figure:
 
      
      	 [bookmark: pgfId-1531883]The well-known TCP or UDP port 135 identifies DCE/RPC traffic in the TCP and UDP transports.
 
      	 [bookmark: pgfId-1531884]The figure does not include RPC over HTTP.
 
     
 
     [bookmark: pgfId-1531885]For RPC over HTTP, connection-oriented DCE/RPC is transported directly over TCP as shown in the figure after an initial setup sequence over HTTP. See Understanding the RPC over HTTP Transport for more information.
 
      
      	 [bookmark: pgfId-1531889]The DCE/RPC preprocessor typically receives SMB traffic on the well-known TCP port 139 for the NetBIOS Session Service or the similarly implemented well-known Windows port 445.
 
     
 
     [bookmark: pgfId-1531890]Because SMB has many functions other than transporting DCE/RPC, the preprocessor first tests whether the SMB traffic is carrying DCE/RPC traffic, stops processing if it is not, and continues processing if it is.
 
      
      	 [bookmark: pgfId-1531891]IP encapsulates all DCE/RPC transports.
 
      	 [bookmark: pgfId-1600680]TCP transports all connection-oriented DCE/RPC.
 
      	 [bookmark: pgfId-1600685]UDP transports connectionless DCE/RPC.
 
     
 
    
 
     
      [bookmark: pgfId-1531908][bookmark: 31510]Understandi[bookmark: marker-1531907]ng the RPC over HTTP Transport
 
     [bookmark: pgfId-1531915]License: Protection
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531925]The Microsoft IIS proxy server and the DCE/RPC server can be on the same host or on different hosts. Separate proxy and server options provide for both cases. Note the following in the figure:
 
      
      	 [bookmark: pgfId-1531926]The DCE/RPC server monitors port 593 for DCE/RPC client traffic, but the firewall blocks port 593.
 
     
 
     [bookmark: pgfId-1531927]Firewalls typically block port 593 by default.
 
      
      	 [bookmark: pgfId-1531928]RPC over HTTP transports DCE/RPC over HTTP using well-known HTTP port 80, which firewalls are likely to permit.
 
      	 [bookmark: pgfId-1531929]Example 1 shows that you would select the RPC over HTTP proxy option to monitor traffic between the DCE/RPC client and the Microsoft IIS RPC proxy server.
 
      	 [bookmark: pgfId-1531930]Example 2 shows that you would select the  RPC over HTTP server option when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers.
 
      	 [bookmark: pgfId-1531931]Traffic is comprised solely of connection-oriented DCE/RPC over TCP after RPC over HTTP completes the proxied setup between the DCE/RPC client and server.
 
     
 
    
 
     
      [bookmark: pgfId-1531934][bookmark: 54378]Selecting DCE/RPC T[bookmark: marker-1531933]arget-Based Policy Options
 
     [bookmark: pgfId-1531941]License: Protection
 
     [bookmark: pgfId-1531942]Each target-based policy allows you to specify the various options below. Note that, except for the Memory Cap Reached and Auto-Detect Policy on SMB Session options, modifying these options could have a negative impact on performance or detection capability. You should not modify them unless you have a thorough understanding of the preprocessor and the interaction between the preprocessor and enabled DCE/RPC rules.
 
     [bookmark: pgfId-1531943]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1531945][bookmark: marker-1531944]Networks
 
     [bookmark: pgfId-1531946]The host IP addresses where you want to apply the DCE/RPC target-based server policy. 
 
     [bookmark: pgfId-1531947]You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 255 total profiles including the default policy. For information on specifying IPv4 and IPv6 address blocks in the FireSIGHT System, see .
 
     [bookmark: pgfId-1576460]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1576472]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1576462][bookmark: marker-1576461]Policy
 
     [bookmark: pgfId-1531957]The Windows or Samba DCE/RPC implementation used by the targeted host or hosts on your monitored network segment. See Understanding Target-Based DCE/RPC Server Policies for detailed information on these policies.
 
     [bookmark: pgfId-1531961]Note that you can enable the Auto-Detect Policy on SMB Session global option to automatically override the setting for this option on a per session basis when SMB is the DCE/RPC transport. See Auto-Detect Policy on SMB Session.
 
     [bookmark: pgfId-1531966][bookmark: marker-1531965]SMB Invalid Shares
 
     [bookmark: pgfId-1531967]A case-insensitive, alphanumeric text string that identifies one or more SMB shared resources; the preprocessor will detect when there is an attempt to connect to a shared resource that you specify. You can specify multiple shares in a comma-separated list and, optionally, you can enclose shares in quotes, which was required in previous software versions but is no longer required; for example:
 
      
      [bookmark: pgfId-1531968]"C$", D$, "admin", private 
     
 
     [bookmark: pgfId-1531969]The preprocessor detects invalid shares in SMB traffic when you have enabled both SMB ports and SMB traffic detection.
 
     [bookmark: pgfId-1531970]Note that in most cases you should append a dollar sign to a drive named by Windows that you identify as an invalid share. For example, identify drive C as C$ or "C$".
 
     [bookmark: pgfId-1531974]You can enable rule 133:26 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531976][bookmark: marker-1531975]SMB Maximum AndX Chain
 
     [bookmark: pgfId-1531977]The maximum number between 0 and 255 of chained SMB AndX commands to permit. Typically, more than a few chained AndX commands represent anomalous behavior and could indicate an evasion attempt. Specify 1 to permit no chained commands or 0 to disable detecting the number of chained commands.
 
     [bookmark: pgfId-1531978]Note that the preprocessor first counts the number of chained commands and generates an event if accompanying SMB preprocessor rules are enabled and the number of chained commands equals or exceeds the configured value. It then continues processing.
 
      
       
     
 
     
 
     [bookmark: pgfId-1531979]Note Only someone who is expert in the SMB protocol should modify the default setting for this option.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1531983]You can enable rule 133:20 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531985][bookmark: marker-1531984]RPC proxy traffic only
 
     [bookmark: pgfId-1531986]When RPC over HTTP Proxy Ports is enabled, indicates whether detected client-side RPC over HTTP traffic is proxy traffic only or might include other web server traffic. For example, port 80 could carry both proxy and other web server traffic.
 
     [bookmark: pgfId-1531987]When this option is disabled, both proxy and other web server traffic are expected. Enable this option, for example, if the server is a dedicated proxy server. When enabled, the preprocessor tests traffic to determine if it carries DCE/RPC, ignores the traffic if it does not, and continues processing if it does. Note that enabling this option adds functionality only if the RPC over HTTP Proxy Ports check box is also enabled.
 
     [bookmark: pgfId-1531988]RPC over HTTP Proxy Ports
 
     [bookmark: pgfId-1531989]Enables detection of DCE/RPC traffic tunneled by RPC over HTTP over each specified port when your managed device is positioned between the DCE/RPC client and the Microsoft IIS RPC proxy server. See Understanding the RPC over HTTP Transport.
 
     [bookmark: pgfId-1531993]When enabled, you can add any ports where you see DCE/RPC traffic, although this is unlikely to be necessary because web servers typically use the default port for both DCE/RPC and other traffic. When enabled, you would not enable RPC over HTTP Proxy Auto-Detect Ports, but you would enable the RPC Proxy Traffic Only when detected client-side RPC over HTTP traffic is proxy traffic only and does not include other web server traffic.
 
     [bookmark: pgfId-1531994]RPC over HTTP Server Ports
 
     [bookmark: pgfId-1531995]Enables detection of DCE/RPC traffic tunneled by RPC over HTTP on each specified port when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers. See Understanding the RPC over HTTP Transport.
 
     [bookmark: pgfId-1531999]Typically, when you enable this option you should also enable RPC over HTTP Server Auto-Detect Ports with a port range from 1025 to 65535 for that option even if you are not aware of any proxy web servers on your network. Note that the RPC over HTTP server port is sometimes reconfigured, in which case you should add the reconfigured server port to port list for this option.
 
     [bookmark: pgfId-1532000]TCP Ports
 
     [bookmark: pgfId-1532001]Enables detection of DCE/RPC traffic in TCP on each specified port.
 
     [bookmark: pgfId-1532002]Legitimate DCE/RPC traffic and exploits might use a wide variety of ports, and other ports above port 1024 are common. Typically, when this option is enabled you should also enable TCP Auto-Detect Ports with a port range from 1025 to 65535 for that option.
 
     [bookmark: pgfId-1532003]UDP Ports
 
     [bookmark: pgfId-1532004]Enables detection of DCE/RPC traffic in UDP on each specified port.
 
     [bookmark: pgfId-1532005]Legitimate DCE/RPC traffic and exploits might use a wide variety of ports, and other ports above port 1024 are common. Typically, when this option is enabled you should also enable UDP Auto-Detect Ports with a port range from 1025 to 65535 for that option.
 
     [bookmark: pgfId-1532006]SMB Ports
 
     [bookmark: pgfId-1532007]Enables detection of DCE/RPC traffic in SMB on each specified port.
 
     [bookmark: pgfId-1532008]You could encounter SMB traffic using the default detection ports. Other ports are rare. Typically, use the default settings.
 
     [bookmark: pgfId-1532009]RPC over HTTP Proxy Auto-Detect Ports
 
     [bookmark: pgfId-1532010]Enables auto-detection of DCE/RPC traffic tunneled by RPC over HTTP on the specified ports when your managed device is positioned between the DCE/RPC client and the Microsoft IIS RPC proxy server. See Understanding the RPC over HTTP Transport.
 
     [bookmark: pgfId-1532014]When enabled, you would typically specify a port range from 1025 to 65535 to cover the entire range of ephemeral ports.
 
     [bookmark: pgfId-1532015]RPC over HTTP Server Auto-Detect Ports
 
     [bookmark: pgfId-1532016]Enables auto-detection of DCE/RPC traffic tunneled by RPC over HTTP on the specified ports when the Microsoft IIS RPC proxy server and the DCE/RPC server are located on different hosts and the device monitors traffic between the two servers. See Understanding the RPC over HTTP Transport.
 
     [bookmark: pgfId-1532020]TCP Auto-Detect Ports
 
     [bookmark: pgfId-1532021]Enables auto-detection of DCE/RPC traffic in TCP on the specified ports.
 
     [bookmark: pgfId-1532022]UDP Auto-Detect Ports
 
     [bookmark: pgfId-1532023]Enables auto-detection of DCE/RPC traffic in UDP on each specified port.
 
     [bookmark: pgfId-1532024]SMB Auto-Detect Ports
 
     [bookmark: pgfId-1532025]Enables auto-detection of DCE/RPC traffic in SMB.
 
     [bookmark: pgfId-1532026]SMB File Inspection
 
     [bookmark: pgfId-1532027]Enables inspection of SMB traffic for file detection. You have the following options:
 
     [bookmark: pgfId-1532028] – Select Off to disable file inspection.
 
     [bookmark: pgfId-1532029] – Select Only to inspect file data without inspecting the DCE/RPC traffic in SMB. Selecting this option can improve performance over inspecting both files and DCE/RPC traffic. 
 
     [bookmark: pgfId-1532030] – Select On to inspect both files and the DCE/RPC traffic in SMB. Selecting this option can impact performance. 
 
     [bookmark: pgfId-1532031]Inspection of SMB traffic for the following is not supported:
 
     [bookmark: pgfId-1532032] – files transferred in SMB 2.x and SMB 3.x
 
     [bookmark: pgfId-1532033] – files transferred in an established TCP or SMB session before this option is enabled and the policy applied
 
     [bookmark: pgfId-1532034] – files transferred concurrently in a single TCP or SMB session
 
     [bookmark: pgfId-1532035] – files transferred across multiple TCP or SMB sessions
 
     [bookmark: pgfId-1532036] – files transferred with non-contiguous data, such as when message signing is negotiated
 
     [bookmark: pgfId-1532037] – files transferred with different data at the same offset, overlapping the data
 
     [bookmark: pgfId-1532038] – files opened on a remote client for editing that the client saves to the file server
 
     [bookmark: pgfId-1532039]SMB File Inspection Depth
 
     [bookmark: pgfId-1532040]If SMB File Inspection is set to Only or On, the number of bytes inspected when a file is detected in SMB traffic. Specify one of the following: 
 
     [bookmark: pgfId-1532041] – an integer from 1 to 2147483647 (about 2GB)
 
     [bookmark: pgfId-1532042] – 0 to inspect the entire file
 
     [bookmark: pgfId-1532043] – -1 to disable file inspection
 
     [bookmark: pgfId-1532044]Enter a value in this field equal to or smaller than the one defined in your access control policy. If you set a value for this option larger than the one defined for Limit the number of bytes inspected when doing file type detection, the system uses the access control policy setting as the functional maximum.See Tuning File and Malware Inspection Performance and Storage for more information.
 
     [bookmark: pgfId-1532048]If SMB File Inspection is set to Off, this field is disabled.
 
    
 
     
      [bookmark: pgfId-1532052][bookmark: 24129]Configuring the DCE/RPC Preprocessor
 
     [bookmark: pgfId-1532059]License: Protection
 
     [bookmark: pgfId-1532061]You can configure DCE/RPC preprocessor global options and one or more target-based server policies.
 
     [bookmark: pgfId-1532062]The preprocessor does not generate events unless you enable rules with generator ID (GID) 133. See Selecting Global DCE/RPC Options and Selecting DCE/RPC Target-Based Policy Options for rules associated with specific detection options; see also Setting Rule States.
 
     [bookmark: pgfId-1532072]In addition, most DCE/RPC preprocessor rules generate events against anomalies and evasion techniques detected in SMB, connection-oriented DCE/RPC, or connectionless DCE/RPC traffic. The following table identifies the rules that you can enable for each type of traffic.
 
     [bookmark: pgfId-1532099]
 
      
       
        
        [bookmark: pgfId-1532079]Table 27-1 [bookmark: 59387]Traffic-Associated DCE/RPC Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532083]Traffic 
          
  
         	 
           
           [bookmark: pgfId-1532085]Preprocessor Rule GID:SID 
          
  
        
 
         
         	[bookmark: pgfId-1532087]SMB
  
         	[bookmark: pgfId-1532089]133:2 through 133:26, and 133:48 through 133:57
  
        
 
         
         	[bookmark: pgfId-1532091]Connection-Oriented DCE/RPC
  
         	[bookmark: pgfId-1532093]133:27 through 133:39
  
        
 
         
         	[bookmark: pgfId-1532096][bookmark: marker-1532095]Detect Connectionless DCE/RPC
  
         	[bookmark: pgfId-1532098]133:40 through 133:43
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532100]To configure the DCE/RPC preprocessor:
 
     [bookmark: pgfId-1532104]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1608952]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1532106]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532111]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532115]The Policy Information page appears.
 
     [bookmark: pgfId-1532117]Step 3 [bookmark: 19245]Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532118]The Settings page appears.
 
     [bookmark: pgfId-1532119]Step 4 You have two choices, depending on whether DCE/RPC Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532120]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532121]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532122]The DCE/RPC Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532129]Step 5 You can modify any of the options described in Selecting Global DCE/RPC Options.
 
     [bookmark: pgfId-1532130]Step 6 You have two options:
 
      
       
       	 [bookmark: pgfId-1532134]Add a new target-based policy. Click the add icon (
 
      
 
      [image: ] ) next to 
       Servers on the left side of the page. The Add Target pop-up window appears. Specify a one or more IP addresses in the 
       Server Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1532135]You can specify a single IP address or address block, or a comma-separated list of either or both. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1532142]You can configure up to 255 policies, including the default policy. 
 
     [bookmark: pgfId-1601119]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1572617]A new entry appears in the list of servers on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the profile you added.
 
      
       
       	 [bookmark: pgfId-1572618]Modify the settings for an existing target-based policy. Click the configured address for a policy you have added under  Servers on the left side of the page, or click  default .
 
      
 
     
 ) next to the policy you want to remove. 
     
 
     [bookmark: pgfId-1532149]Step 7 You can modify any of the following target-based policy options:
 
      
       
       	 [bookmark: pgfId-1532150]To specify the host or hosts where you want to apply the DCE/RPC target-based server policy, enter a single IP address or address block, or a comma-separated list of either or both in the  Networks field.
 
      
 
     
 
     [bookmark: pgfId-1600819]You can specify up to 255 total profiles including the default policy. Note that you cannot modify the setting for Networks in the default policy. The default policy applies to all servers on your network that are not identified in another policy. 
 
      
       
       	 [bookmark: pgfId-1600821]To specify the type of policy you want to apply to the specified host or hosts on your network segment, select one of the Windows or Samba policy types from the  Policy drop-down list.
 
      
 
     
 
     [bookmark: pgfId-1532153]Note that you can enable the Auto-Detect Policy on SMB Session global option to automatically override the setting for this option on a per session basis when SMB is the DCE/RPC transport. See Auto-Detect Policy on SMB Session.
 
      
       
       	 [bookmark: pgfId-1532157]To set the preprocessor to detect when there is an attempt to connect to specified shared SMB resources, enter a single or comma-separated list of the case-insensitive strings that identify the shared resources in the  SMB Invalid Shares field. Optionally, enclose individual strings in quotes, which was required in previous software versions but is no longer required.
 
      
 
     
 
     [bookmark: pgfId-1532158]For example, to detect shared resources named C$, D$, admin, and private, you could enter:
 
      
      [bookmark: pgfId-1532159]"C$", D$, "admin", private 
     
 
     [bookmark: pgfId-1532160]Note that to detect SMB invalid shares, you must also enable SMB Ports or SMB Auto-Detect Ports, and enable the global SMB Traffics option.
 
     [bookmark: pgfId-1532161]Note also that in most cases you should append a dollar sign to a drive named by Windows that you identify as an invalid share. For example, you would enter C$ or "C$" to identify drive C.
 
      
       
       	 [bookmark: pgfId-1532162]To inspect files detected in DCE/RPC traffic in SMB without analyzing the DCE/RPC traffic, from the  SMB File Inspection drop-down list, select  Only . To inspect files detected in DCE/RPC traffic in SMB as well as the DCE/RPC traffic, from the  SMB File Inspection drop-down list, select  On . Enter a number of bytes to inspect in a detected file in the  SMB File Inspection Depth field. Enter  0 to inspect detected files in their entirety.
 
       	 [bookmark: pgfId-1532163]To specify a maximum number of chained SMB AndX commands to permit, enter 0 to 255 in the  SMB Maximum AndX Chains field. Specify  1  to permit no chained commands. Specify  0 or leave this option blank to disable this feature.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1532164]Note Only someone who is expert in the SMB protocol should modify the setting for the SMB Maximum AndX Chains option.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1532165]To enable the processing of DCE/RPC traffic over ports known to carry DCE/RPC traffic for a Windows policy transport, select or clear the check box next to a detection transport and, optionally, add or delete ports for the transport.
 
      
 
     
 
     [bookmark: pgfId-1532166]Select one or any combination of RPC over HTTP Proxy Ports, RPC over HTTP Server Ports, TCP Ports, and UDP Ports for a Windows policy. Select RPC Proxy Traffic Only when RPC over HTTP proxy is enabled and detected client-side RPC over HTTP traffic is proxy traffic only; that is, when it does not include other web server traffic.
 
     [bookmark: pgfId-1532167]Select SMB Ports for a Samba policy.
 
     [bookmark: pgfId-1532171]In most cases, use the default settings. See Understanding DCE/RPC Transports, Understanding the RPC over HTTP Transport, and Selecting DCE/RPC Target-Based Policy Options for more information.
 
     [bookmark: pgfId-1532178]You can type a single port, a range of port numbers separated by a dash (-), or a comma-separated list of port numbers and ranges.
 
      
       
       	 [bookmark: pgfId-1532179]To test whether specified ports carry DCE/RPC traffic and continue processing when they do, select or clear the check box next to an auto-detection transport and, optionally, add or delete ports for the transport.
 
      
 
     
 
     [bookmark: pgfId-1532180]Select one or any combination of RPC over HTTP Server Auto-Detect Ports, TCP Auto-Detect Ports, and UDP Auto-Detect Ports for a Windows policy.
 
     [bookmark: pgfId-1532181]Note that you would rarely, if ever, select RPC over HTTP Proxy Auto-Detect Ports or SMB Auto-Detect Ports.
 
     [bookmark: pgfId-1532182]Typically, specify a port range from 1025 to 65535 for auto-detection ports that you enable to cover the entire range of ephemeral ports. See Understanding DCE/RPC Transports, Understanding the RPC over HTTP Transport, and Selecting DCE/RPC Target-Based Policy Options for more information.
 
     [bookmark: pgfId-1588630]See Selecting DCE/RPC Target-Based Policy Options for more information.
 
     [bookmark: pgfId-1588631]Step 8 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1588635]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1588640][bookmark: 61366]Dete[bookmark: marker-1588637]cting Expl[bookmark: marker-1588638]oits in D[bookmark: DNS]NS Name Server Responses
 
    [bookmark: pgfId-1532215]License: Protection
 
    [bookmark: pgfId-1532216]The DNS preprocessor inspects DNS name server responses for the following specific exploits:
 
     
     	 [bookmark: pgfId-1532217]Overflow attempts on RData text fields
 
     	 [bookmark: pgfId-1532218]Obsolete DNS resource record types
 
     	 [bookmark: pgfId-1532219]Experimental DNS resource record types
 
    
 
    [bookmark: pgfId-1532220]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1532224]Understanding DNS Preprocessor Resource Record Inspection
 
     	 [bookmark: pgfId-1532228]Detecting Overflow Attempts in RData Text Fields
 
     	 [bookmark: pgfId-1532232]Detecting Obsolete DNS Resource Record Types
 
     	 [bookmark: pgfId-1532236]Detecting Experimental DNS Resource Record Types
 
     	 [bookmark: pgfId-1532240]Configuring the DNS Preprocessor
 
    
 
     
      [bookmark: pgfId-1532243][bookmark: 97726]Understanding DNS Preprocessor Res[bookmark: marker-1532242]ource Record Inspection
 
     [bookmark: pgfId-1532250]License: Protection
 
     [bookmark: pgfId-1532251]The most common type of DNS name server response provides one or more IP addresses that correspond to domain names in the query that prompted the response. Other types of server responses provide, for example, the destination for an email message or the location of a name server that can provide information not available from the server originally queried.
 
     [bookmark: pgfId-1532252]A DNS response is comprised of a message header, a Question section that contains one or more requests, and three sections that respond to requests in the Question section (Answer, Authority, and Additional Information). Responses in these three sections reflect the information in resource records (RR) maintained on the name server. The following table describes these three sections.
 
     [bookmark: pgfId-1532288]
 
      
       
        
        [bookmark: pgfId-1532259]Table 27-2 [bookmark: 42311]DNS Name Server RR Responses 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532265]This section... 
          
  
         	 
           
           [bookmark: pgfId-1532267]Includes... 
          
  
         	 
           
           [bookmark: pgfId-1532269]For example... 
          
  
        
 
         
         	[bookmark: pgfId-1532271]Answer
  
         	[bookmark: pgfId-1532273]Optionally, one or more resource records that provide a specific answer to a query
  
         	[bookmark: pgfId-1532275]The IP address corresponding to a domain name
  
        
 
         
         	[bookmark: pgfId-1532277]Authority
  
         	[bookmark: pgfId-1532279]Optionally, one or more resource records that point to an authoritative name server
  
         	[bookmark: pgfId-1532281]The name of an authoritative name server for the response
  
        
 
         
         	[bookmark: pgfId-1532283]Additional Information
  
         	[bookmark: pgfId-1532285]Optionally, one or more resource records that provided additional information related to the Answer sections
  
         	[bookmark: pgfId-1532287]The IP address of another server to query
  
        
 
        
      
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1532298]Theoretically, any type of resource record can be used in the Answer, Authority, or Additional Information section of a name server response message. The DNS preprocessor inspects any resource record in each of the three response sections for the exploits it detects.
 
     [bookmark: pgfId-1532299]The Type and RData resource record fields are of particular importance to the DNS preprocessor. The Type field identifies the type of resource record. The RData (resource data) field provides the response content. The size and content of the RData field differs depending on the type of resource record.
 
     [bookmark: pgfId-1532300]DNS messages typically use the UDP transport protocol but also use TCP when the message type requires reliable delivery or the message size exceeds UDP capabilities. The DNS preprocessor inspects DNS server responses in both UDP and TCP traffic. 
 
     [bookmark: pgfId-1532307]The DNS preprocessor does not inspect TCP sessions picked up in midstream, and ceases inspection if a session loses state because of dropped packets.
 
     [bookmark: pgfId-1532308]The typical port to configure for the DNS preprocessor is well-known port 53, which DNS name servers use for DNS messages in both UDP and TCP.
 
    
 
     
      [bookmark: pgfId-1532311][bookmark: 23655]Detecting Overflow Attem[bookmark: marker-1532310]pts in RData Text Fields
 
     [bookmark: pgfId-1532318]License: Protection
 
     [bookmark: pgfId-1532319]When the resource record type is TXT (text), the RData field is a variable-length ASCII text field.
 
     [bookmark: pgfId-1532320]When selected, the DNS preprocessor Detect Overflow attempts on RData Text fields option detects a specific vulnerability identified by entry CVE-2006-3441 in MITRE’s Current Vulnerabilities and Exposures database. This is a known vulnerability in Microsoft Windows 2000 Service Pack 4, Windows XP Service Pack 1 and Service Pack 2, and Windows Server 2003 Service Pack 1. An attacker can exploit this vulnerability and take complete control of a host by sending or otherwise causing the host to receive a maliciously crafted name server response that causes a miscalculation in the length of an RData text field, resulting in a buffer overflow.
 
     [bookmark: pgfId-1532321]You should enable this feature when your network might include hosts running operating systems that have not been upgraded to correct this vulnerability.
 
     [bookmark: pgfId-1532325]You can enable rule 131:3 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1532328][bookmark: 60576]Detecting Obs[bookmark: marker-1532327]olete DNS Resource Record Types
 
     [bookmark: pgfId-1532335]License: Protection
 
     [bookmark: pgfId-1532336]RFC 1035 identifies several resource record types as obsolete. Because these are obsolete record types, some systems do not account for them and may be open to exploits. You would not expect to encounter these record types in normal DNS responses unless you have purposely configured your network to include them.
 
      
       
        
        [bookmark: pgfId-1532344]Table 27-3 [bookmark: 36736]Obsolete DNS Resource Record Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532350]RR Type 
          
  
         	 
           
           [bookmark: pgfId-1532352]Code 
          
  
         	 
           
           [bookmark: pgfId-1532354]Description 
          
  
        
 
         
         	[bookmark: pgfId-1532356]3
  
         	[bookmark: pgfId-1532358]MD
  
         	[bookmark: pgfId-1532360]a mail destination
  
        
 
         
         	[bookmark: pgfId-1532362]4
  
         	[bookmark: pgfId-1532364]MF
  
         	[bookmark: pgfId-1532366]a mail forwarder
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532371]You can enable rule 131:1 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1532374][bookmark: 56970]Detecting Experi[bookmark: marker-1532373]mental DNS Resource Record Types
 
     [bookmark: pgfId-1532381]License: Protection
 
     [bookmark: pgfId-1532383]RFC 1035 identifies several resource record types as experimental. Because these are experimental record types, some systems do not account for them and may be open to exploits. You would not expect to encounter these record types in normal DNS responses unless you have purposely configured your network to include them.
 
      
       
        
        [bookmark: pgfId-1532391]Table 27-4 [bookmark: 41386]Experimental DNS Resource Record Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532397]RR Type 
          
  
         	 
           
           [bookmark: pgfId-1532399]Code 
          
  
         	 
           
           [bookmark: pgfId-1532401]Description 
          
  
        
 
         
         	[bookmark: pgfId-1532403]7
  
         	[bookmark: pgfId-1532405]MB
  
         	[bookmark: pgfId-1532407]a mailbox domain name
  
        
 
         
         	[bookmark: pgfId-1532409]8
  
         	[bookmark: pgfId-1532411]MG
  
         	[bookmark: pgfId-1532413]a mail group member
  
        
 
         
         	[bookmark: pgfId-1532415]9
  
         	[bookmark: pgfId-1532417]MR
  
         	[bookmark: pgfId-1532419]a mail rename domain name
  
        
 
         
         	[bookmark: pgfId-1532421]10
  
         	[bookmark: pgfId-1532423]NUL
  
         	[bookmark: pgfId-1532425]a null resource record
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532430]You can enable rule 131:2 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1532434][bookmark: 24541]Configurin[bookmark: marker-1532433]g the DNS Preprocessor
 
     [bookmark: pgfId-1532441]License: Protection
 
     [bookmark: pgfId-1532442]Use the following procedure to configure the DNS preprocessor. For more information on configuring the options on this page, see Detecting Overflow Attempts in RData Text Fields, Detecting Obsolete DNS Resource Record Types, and Detecting Experimental DNS Resource Record Types.
 
     [bookmark: pgfId-1532452]To configure the DNS preprocessor:
 
     [bookmark: pgfId-1532456]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1608967]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572720]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572725]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572729]The Policy Information page appears.
 
     [bookmark: pgfId-1572731]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572732]The Settings page appears.
 
     [bookmark: pgfId-1532471]Step 4 You have two choices, depending on whether DNS Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532472]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532473]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532474]The DNS Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532478]Step 5 Optionally, you can modify any of the following in the Settings area:
 
      
       
       	 [bookmark: pgfId-1532479]Specify the source port or ports the DNS preprocessor should monitor for DNS server responses in the  Ports field. Separate multiple ports with commas.
 
       	 [bookmark: pgfId-1532480]Select the  Detect Overflow Attempts on RData  Text  fields  check box to enable detection of buffer overflow attempts in RData text fields. 
 
       	 [bookmark: pgfId-1532481]Select the  Detect Obsolete DNS RR Types check box to enable detection of obsolete resource record types. 
 
       	 [bookmark: pgfId-1532482]Select the  Detect Experimental DNS RR Types check box to detect experimental resource record types. 
 
      
 
     
 
     [bookmark: pgfId-1532485]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1532489]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532497][bookmark: 88566]Deco[bookmark: FTPTelnet]ding FT[bookmark: marker-1532493]P and Te[bookmark: marker-1532494]lnet Traf[bookmark: marker-1532495][bookmark: marker-1532496]fic
 
    [bookmark: pgfId-1532505]License: Protection
 
    [bookmark: pgfId-1532506]The FTP/Telnet decoder analyzes FTP and telnet data streams, normalizing FTP and telnet commands before processing by the rules engine. 
 
    [bookmark: pgfId-1532515]You must enable FTP and telnet preprocessor rules, which have generator IDs (GIDs) of 125 and 126, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1532519]For more information, see the following topics:
 
     
     	 [bookmark: pgfId-1532523]Understanding Global FTP and Telnet Options
 
     	 [bookmark: pgfId-1532527]Configuring Global FTP/Telnet Options
 
     	 [bookmark: pgfId-1532531]Understanding Telnet Options
 
     	 [bookmark: pgfId-1532535]Configuring Telnet Options
 
     	 [bookmark: pgfId-1532539]Understanding Server-Level FTP Options
 
     	 [bookmark: pgfId-1532543]Configuring Server-Level FTP Options
 
     	 [bookmark: pgfId-1532547]Understanding Client-Level FTP Options
 
     	 [bookmark: pgfId-1532551]Configuring Client-Level FTP Options
 
    
 
     
      [bookmark: pgfId-1532555][bookmark: 27293]Understanding Global [bookmark: marker-1532553]FTP and [bookmark: marker-1532554]Telnet Options
 
     [bookmark: pgfId-1532562]License: Protection
 
     [bookmark: pgfId-1532563]You can set global options to determine whether the FTP/Telnet decoder performs stateful or stateless inspection of packets, whether the decoder detects encrypted FTP or telnet sessions, and whether the decoder continues to check a data stream after it encounters encrypted data. 
 
     [bookmark: pgfId-1532564]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1532565]Stateful Inspection
 
     [bookmark: pgfId-1532566]When selected, causes the FTP/Telnet decoder to save state and provide session context for individual packets and only inspects reassembled sessions. When cleared, analyzes each individual packet without session context. 
 
     [bookmark: pgfId-1532567]To check for FTP data transfers, this option must be selected.
 
     [bookmark: pgfId-1532568]Detect Encrypted Traffic
 
     [bookmark: pgfId-1532569]Detects encrypted telnet and FTP sessions.
 
     [bookmark: pgfId-1532572]You can enable rules 125:7 and 126:2 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532574]Continue to Inspect Encrypted Data
 
     [bookmark: pgfId-1532575]Instructs the preprocessor to continue checking a data stream after it is encrypted, looking for eventual decrypted data. 
 
    
 
     
      [bookmark: pgfId-1532579][bookmark: 90640]Configuring Global [bookmark: marker-1532577]FTP/[bookmark: marker-1532578]Telnet Options
 
     [bookmark: pgfId-1532586]License: Protection
 
     [bookmark: pgfId-1532587]You need to configure global options for the FTP/Telnet decoder to control whether stateless or stateful inspection is performed, encrypted traffic is detected, and whether the decoder should continue to check for decrypted data in a data stream that it has identified as encrypted. For more information on global settings, see Understanding Global FTP and Telnet Options.
 
     [bookmark: pgfId-1532591]To configure global options:
 
     [bookmark: pgfId-1532595]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1608986]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572751]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572756]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572760]The Policy Information page appears.
 
     [bookmark: pgfId-1572762]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572763]The Settings page appears.
 
     [bookmark: pgfId-1532609]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532610]Step 4 You have two choices, depending on whether FTP and Telnet Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532611]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532612]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532613]The FTP and Telnet Configuration page appears.
 
     [bookmark: pgfId-1532614]A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532620]Tip For more information on configuring the other options on this page, see Configuring Telnet Options, Configuring Server-Level FTP Options, and Configuring Client-Level FTP Options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532628]Step 5 Optionally, you can modify any of the following in the Global Settings page area:
 
      
       
       	 [bookmark: pgfId-1532629]Select  Stateful Inspection  to examine reassembled TCP streams containing FTP packets. Clear  Stateful Inspection to inspect only unreassembled packets.
 
       	 [bookmark: pgfId-1532637]Select  Detect Encrypted Traffic  to detect encrypted traffic. Clear  Detect Encrypted Traffic to ignore encrypted traffic.
 
       	 [bookmark: pgfId-1532638]If needed, select  Continue to Inspect Encrypted Data to continue checking a stream after it becomes encrypted, in case it becomes decrypted again and can be processed.
 
      
 
     
 
     [bookmark: pgfId-1532641]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1532645]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532648][bookmark: 31910]Understanding [bookmark: marker-1532647]Telnet Options
 
     [bookmark: pgfId-1532655]License: Protection
 
     [bookmark: pgfId-1532656]You can enable or disable normalization of telnet commands by the FTP/Telnet decoder, enable or disable a specific anomaly case, and set the threshold number of Are You There (AYT) attacks to permit.
 
     [bookmark: pgfId-1532657]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1532659][bookmark: 83423]Ports
 
     [bookmark: pgfId-1532660]Indicates the ports whose telnet traffic you want to normalize. In the interface, list multiple ports separated by commas.
 
     [bookmark: pgfId-1532665]Normalize
 
     [bookmark: pgfId-1532666]Normalizes telnet traffic to the specified ports.
 
     [bookmark: pgfId-1532667]Detect Anomalies
 
     [bookmark: pgfId-1532668]Enables detection of Telnet SB (subnegotiation begin) without the corresponding SE (subnegotiation end).
 
     [bookmark: pgfId-1532669]Telnet supports subnegotiation, which begins with SB (subnegotiation begin) and must end with an SE (subnegotiation end). However, certain implementations of Telnet servers will ignore the SB without a corresponding SE. This is anomalous behavior that could be an evasion case. Because FTP uses the Telnet protocol on the control connection, it is also susceptible to this behavior.
 
     [bookmark: pgfId-1532670]You can enable rule 126:3 to generate an event when this anomaly is detected in Telnet traffic, and rule 125:9 when it is detected on the FTP command channel. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532674]Are You There Attack Threshold Number
 
     [bookmark: pgfId-1532678]Detects when the number of consecutive AYT commands exceeds the specified threshold. Cisco recommends that you set the AYT threshold to a value no higher than 20.
 
     [bookmark: pgfId-1532682]You can enable rule 126:1 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1532685][bookmark: 84398]Configuring [bookmark: marker-1532684]Telnet Options
 
     [bookmark: pgfId-1532692]License: Protection
 
     [bookmark: pgfId-1532693]You can enable or disable normalization, enable or disable a specific anomaly case, and control the threshold number of Are You There (AYT) attacks to permit. For additional information on telnet options, see Understanding Telnet Options.
 
     [bookmark: pgfId-1532697]To configure telnet options:
 
     [bookmark: pgfId-1532701]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609007]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572799]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572804]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572808]The Policy Information page appears.
 
     [bookmark: pgfId-1572809]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572810]The Settings page appears.
 
     [bookmark: pgfId-1532716]Step 4 You have two choices, depending on whether FTP and Telnet Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532717]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532718]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532719]The FTP and Telnet Configuration page appears.
 
     [bookmark: pgfId-1532720]A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532726]Tip For more information on configuring the other options on this page, see Configuring Global FTP/Telnet Options, Configuring Server-Level FTP Options, and Configuring Client-Level FTP Options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532734]Step 5 Optionally, you can modify any of the following in the Telnet Settings page area:
 
      
       
       	 [bookmark: pgfId-1532735]Specify the port or ports where telnet traffic should be decoded in the  Ports field. Telnet typically connects to TCP port 23. Separate multiple ports with commas.
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1532740] 
      Caution Because encrypted traffic (SSL) cannot be decoded, adding port 22 (SSH) could yield unexpected results. 
       
       
 
      
 
     
 
      
       
       	 [bookmark: pgfId-1532741]Select or clear the  Normalize Telnet Protocol Options check box to enable or disable telnet normalization.
 
       	 [bookmark: pgfId-1532742]Select or clear the  Detect Anomalies Telnet Protocol Options check box to enable or disable anomaly detection.
 
       	 [bookmark: pgfId-1532743]Specify an  Are You There Attack Threshold Number  of consecutive AYT commands to permit.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1532747]Tip Cisco recommends that you set the AYT threshold to a value no higher than the default value.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532750]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1532754]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532757][bookmark: 65781]Understanding Server-Level [bookmark: marker-1532756]FTP Options
 
     [bookmark: pgfId-1532764]License: Protection
 
     [bookmark: pgfId-1532765]You can set options for decoding on multiple FTP servers. Each server profile you create contains the server IP address and the ports on the server where traffic should be monitored. You can specify which FTP commands to validate and which to ignore for a particular server, and set maximum parameter lengths for commands. You can also set the specific command syntax the decoder should validate against for particular commands and set alternate maximum command parameter lengths.
 
     [bookmark: pgfId-1532766]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1532767]Networks
 
     [bookmark: pgfId-1532768]Use this option to specify one or more IP addresses of FTP servers.
 
     [bookmark: pgfId-1532769]You can specify a single IP address or address block, or a comma-separated list comprised of either or both. You can configure up to 1024 characters, and you can specify up to 255 profiles including the default profile. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1600858]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or address block for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1600866]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1600860]Ports
 
     [bookmark: pgfId-1532778]Use this option to specify the ports on the FTP server where the managed device should monitor traffic. In the interface, list multiple ports separated by commas.
 
     [bookmark: pgfId-1532783]File Get Commands
 
     [bookmark: pgfId-1532784]Use this option to define the FTP commands used to transfer files from server to client. Do not change these values unless directed to do so by Support.
 
     [bookmark: pgfId-1532785]File Put Commands
 
     [bookmark: pgfId-1532786]Use this option to define the FTP commands used to transfer files from client to server. Do not change these values unless directed to do so by Support.
 
     [bookmark: pgfId-1532787]Additional FTP Commands
 
     [bookmark: pgfId-1532788]Use this line to specify the additional commands that the decoder should detect. Separate additional commands by spaces.
 
     [bookmark: pgfId-1532789]Default Max Parameter Length
 
     [bookmark: pgfId-1532790]Use this option to detect the maximum parameter length for commands where an alternate maximum parameter length has not been set.
 
     [bookmark: pgfId-1532794]You can enable rule 125:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532795]Alternate Max Parameter Length
 
     [bookmark: pgfId-1532796]Use this option to specify commands where you want to detect a different maximum parameter length, and to specify the maximum parameter length for those commands. Click Add to add lines where you can specify a different maximum parameter length to detect for particular commands.
 
     [bookmark: pgfId-1532797]Check Commands for String Format Attacks
 
     [bookmark: pgfId-1532798]Use this option to check the specified commands for string format attacks.
 
     [bookmark: pgfId-1532802]You can enable rule 125:5 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532803]Command Validity
 
     [bookmark: pgfId-1532806]Use this option to enter a valid format for a specific command. See Creating FTP Command Parameter Validation Statements for information on creating FTP command parameter validation statements to validate the syntax of a parameter received as part of an FTP communication. Click Add to add a command validation line. 
 
     [bookmark: pgfId-1532810]You can enable rules 125:2 and 125:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532812]Ignore FTP Transfers
 
     [bookmark: pgfId-1532813]Use this option to improve performance on FTP data transfers by disabling all inspection other than state inspection on the data transfer channel.
 
     [bookmark: pgfId-1532814]Detect Telnet Escape Codes within FTP Commands
 
     [bookmark: pgfId-1532815]Use this option to detect when telnet commands are used over the FTP command channel.
 
     [bookmark: pgfId-1532819]You can enable rule 125:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532820]Ignore Erase Commands during Normalization 
 
     [bookmark: pgfId-1532821]When Detect Telnet Escape Codes within FTP Commands is selected, use this option to ignore telnet character and line erase commands when normalizing FTP traffic. The setting should match how the FTP server handles telnet erase commands. Note that newer FTP servers typically ignore telnet erase commands, while older servers typically process them.
 
     [bookmark: pgfId-1546149]Troubleshooting Options: Log FTP Command Validation Configuration 
 
     [bookmark: pgfId-1546145]Support might ask you during a troubleshooting call to configure your system to print the configuration information for each FTP command listed for the server.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1546341] 
      Caution Changing the setting for this troubleshooting option affects performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1532823][bookmark: 92394]Creating FTP Command Parameter Validation Statements
 
     [bookmark: pgfId-1532830]License: Protection
 
     [bookmark: pgfId-1532831]When setting up a validation statement for an FTP command, you can specify a group of alternative parameters by separating the parameters with spaces. You can also create a binary OR relationship between two parameters by separating them with a pipe character (|) in the validation statement. Surrounding parameters by square brackets ([]) indicates that those parameters are optional. Surrounding parameters with curly brackets ({}) indicates that those parameters are required.
 
     [bookmark: pgfId-1532832]You can create FTP command parameter validation statements to validate the syntax of a parameter received as part of an FTP communication. See Understanding Server-Level FTP Options for more information.
 
      
       
        
        [bookmark: pgfId-1532842]Table 27-5 FTP Command Parameters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532846]If you use... 
          
  
         	 
           
           [bookmark: pgfId-1532848]The following validation occurs... 
          
  
        
 
         
         	[bookmark: pgfId-1532850]int
  
         	[bookmark: pgfId-1532852]The represented parameter must be an integer.
  
        
 
         
         	[bookmark: pgfId-1532854]number
  
         	[bookmark: pgfId-1532856]The represented parameter must be an integer between 1 and 255.
  
        
 
         
         	[bookmark: pgfId-1532858]char _chars 
  
         	[bookmark: pgfId-1532860]The represented parameter must be a single character and a member of the characters specified in the _chars argument.
 [bookmark: pgfId-1532861]For example, defining the command validity for MODE with the validation statement char SBC checks that the parameter for the MODE command comprises the character S (representing Stream mode), the character B (representing Block mode), or the character C (representing Compressed mode).
  
        
 
         
         	[bookmark: pgfId-1532863]date _datefmt 
  
         	[bookmark: pgfId-1532865]If _datefmt contains #, the represented parameter must be a number.
 [bookmark: pgfId-1532866]If _datefmt contains C, the represented parameter must be a character.
 [bookmark: pgfId-1532867]If _datefmt contains literal strings, the represented parameter must match the literal string.
  
        
 
         
         	[bookmark: pgfId-1532869]string
  
         	[bookmark: pgfId-1532871]The represented parameter must be a string.
  
        
 
         
         	[bookmark: pgfId-1532873]host_port
  
         	[bookmark: pgfId-1532875]The represented parameter must be a valid host port specifier as defined by RFC 959, the File Transfer Protocol specification by the Network Working Group.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532877]You can combine the syntax in the table above as needed to create parameter validation statements that correctly validate each FTP command where you need to validate traffic. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1532878]Note When you include a complex expression in a TYPE command, surround it by spaces. Also, surround each operand within the expression by spaces. For example, type char A | B , not char A|B.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532881][bookmark: 45055]Configuring Server-Level [bookmark: marker-1532880]FTP Options
 
     [bookmark: pgfId-1532888]License: Protection
 
     [bookmark: pgfId-1532889]You can configure several options at the server level. For each FTP server you add, you can specify the ports to be monitored, the commands to validate, the default maximum parameter length for commands, alternate parameter lengths for specific commands, and validation syntax for particular commands. You can also choose whether to check for string format attacks and telnet commands on the FTP channel and whether to print configuration information with each command. For additional information on server-level FTP options, see Understanding Server-Level FTP Options.
 
     [bookmark: pgfId-1532893]To configure server-level FTP options:
 
     [bookmark: pgfId-1532897]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609022]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572828]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572833]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572837]The Policy Information page appears.
 
     [bookmark: pgfId-1572838]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572839]The Settings page appears.
 
     [bookmark: pgfId-1532912]Step 4 You have two choices, depending on whether FTP and Telnet Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532913]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532914]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532915]The FTP and Telnet Configuration page appears.
 
     [bookmark: pgfId-1532916]A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532922]Tip For more information on configuring the other options on this page, see Configuring Global FTP/Telnet Options, Configuring Telnet Options, and Configuring Client-Level FTP Options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532930]Step 5 You have two options:
 
      
       
       	 [bookmark: pgfId-1532934]Add a new server profile. Click the add icon (
 
      
 
      [image: ] ) next to 
       FTP Server on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses for the client in the 
       Server Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1532935]You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 1024 characters, and you can configure up to 255 policies, including the default policy. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1601879]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1532942]A new entry appears in the list of FTP servers on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the profile you added.
 
      
       
       	 [bookmark: pgfId-1577355]Modify the settings for an existing server profile. Click the configured address for a profile you have added under  FTP Server on the left side of the page, or click  default .
 
      
 
     
 ) next to the profile you want to remove. 
     
 
     [bookmark: pgfId-1532948]Step 6 Optionally, you can modify any of the following in the Configuration page area:
 
      
       
       	 [bookmark: pgfId-1532949]Modify the address or addresses listed in the  Networks field and click any other area of the page.
 
      
 
     
 
     [bookmark: pgfId-1532950]The highlighted address updates on the left side of the page.
 
     [bookmark: pgfId-1579104]Note that you cannot modify the setting for Network in the default profile. The default profile applies to all servers on your network that are not identified in another profile.
 
      
       
       	 [bookmark: pgfId-1579106][bookmark: 62583]Specify any  Ports that should be monitored for FTP traffic. Port 21 is the well-known port for FTP traffic.
 
       	 [bookmark: pgfId-1532958]Update the FTP commands used to transfer files from server to client in the  File Get Commands field.
 
       	 [bookmark: pgfId-1532959]Update the FTP commands used to transfer files from client to server in the  File Put Commands field.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1532960]Note Do not change the values in the File Get Commands and File Put Commands field unless directed to do so by Support.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1532961]To detect additional FTP commands outside of those checked by default by the FTP/Telnet preprocessor, type the commands, separated by spaces in the  Additional FTP Commands field.
 
      
 
     
 
     [bookmark: pgfId-1532962]You can add as many additional FTP commands as needed.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532963]Note Additional commands you may want to add include XPWD, XCWD, XCUP, XMKD, and XRMD. For more information on these commands, see RFC 775, the Directory oriented FTP commands specification by the Network Working Group.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1532964]Specify the default maximum number of bytes for a command parameter in the  Default Max Parameter Length field. 
 
       	 [bookmark: pgfId-1532965]To detect a different maximum parameter length for particular commands, click  Add next to  Alternate Max Parameter Length . In the first text box of the row that appears, specify the maximum parameter length. In the second text box, specify the commands, separated by spaces, where this alternate maximum parameter length should apply.
 
      
 
     
 
     [bookmark: pgfId-1532966]You can add as many alternative maximum parameter lengths as needed.
 
      
       
       	 [bookmark: pgfId-1532967]To check for string format attacks on particular commands, specify the commands, separated by spaces, in the  Check Commands for String Format Attacks text box.
 
       	 [bookmark: pgfId-1532968]To specify the valid format for a command, click  Add next to  Command Validity . Specify the command you want to validate, then type a validation statement for the command parameter. For more information on the validation statement syntax, see Understanding Server-Level FTP Options.
 
       	 [bookmark: pgfId-1532972]To improve performance on FTP data transfers by disabling all inspection other than state inspection on the data transfer channel, enable  Ignore FTP Transfers .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1532973]Note To inspect data transfers, the global FTP/Telnet Stateful Inspection option must be selected. For more information on setting global options, see Understanding Global FTP and Telnet Options.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1532977]To detect when telnet commands are used over the FTP command channel, select  Detect Telnet Escape Codes within FTP Commands .
 
       	 [bookmark: pgfId-1532978]To ignore telnet character and line erase commands when normalizing FTP traffic, enable  Ignore Erase Commands during Normalization .
 
      
 
     
 
     [bookmark: pgfId-1532981]Step 7 Optionally, modify the related troubleshooting option only if asked to do so by Support; click the + sign next to Troubleshooting Options to expand the troubleshooting options section. 
 
     [bookmark: pgfId-1532985]Step 8 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1532989]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532992][bookmark: 14985]Understanding Client-Level [bookmark: marker-1532991]FTP Options
 
     [bookmark: pgfId-1532999]License: Protection
 
     [bookmark: pgfId-1533000]You can create profiles for FTP clients. Within each profile, you can specify the maximum response length for an FTP response from a client. You can also configure whether the decoder detects bounce attacks and use of telnet commands on the FTP command channel for a particular client.
 
     [bookmark: pgfId-1533001]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533002]Networks
 
     [bookmark: pgfId-1533003]Use this option to specify one or more IP addresses of FTP clients.
 
     [bookmark: pgfId-1533004]You can specify a single IP address or address block, or a comma-separated list comprised of either or both. You can specify up to 1024 characters, and you can specify up to 255 profiles including the default profile. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1533011]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or address block for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1600901]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1533012]Max Response Length
 
     [bookmark: pgfId-1533013]Use this option to specify the maximum length of a response string from the FTP client.
 
     [bookmark: pgfId-1533017]You can enable rule 125:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533018]Detect FTP Bounce Attempts
 
     [bookmark: pgfId-1533019]Use this option to detect FTP bounce attacks.
 
     [bookmark: pgfId-1533023]You can enable rule 125:8 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533024]Allow FTP Bounce to
 
     [bookmark: pgfId-1533025]Use this option to configure a list of additional hosts and ports on those hosts on which FTP PORT commands should not be treated as FTP bounce attacks.
 
     [bookmark: pgfId-1533026]Detect Telnet Escape Codes within FTP Commands
 
     [bookmark: pgfId-1533027]Use this option to detect when telnet commands are used over the FTP command channel.
 
     [bookmark: pgfId-1533031]You can enable rule 125:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533032]Ignore Erase Commands During Normalization
 
     [bookmark: pgfId-1533033]When Detect Telnet Escape Codes within FTP Commands is selected, use this option to ignore telnet character and line erase commands when normalizing FTP traffic.The setting should match how the FTP client handles telnet erase commands. Note that newer FTP clients typically ignore telnet erase commands, while older clients typically process them.
 
    
 
     
      [bookmark: pgfId-1533036][bookmark: 47279]Configuring Client-Level [bookmark: marker-1533035]FTP Options
 
     [bookmark: pgfId-1533043]License: Protection
 
     [bookmark: pgfId-1533044]You can configure client profiles for FTP clients to monitor FTP traffic from clients. For additional information on the options you can set for monitoring clients, see Understanding Client-Level FTP Options. For more information on telnet options, see Understanding Telnet Options. For more information on additional FTP options, see Understanding Server-Level FTP Options and Understanding Global FTP and Telnet Options. 
 
     [bookmark: pgfId-1533057]To configure client-level FTP options:
 
     [bookmark: pgfId-1533061]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609045]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572857]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572862]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572866]The Policy Information page appears.
 
     [bookmark: pgfId-1572867]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572868]The Settings page appears.
 
     [bookmark: pgfId-1533076]Step 4 You have two choices, depending on whether FTP and Telnet Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1533077]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1533078]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1533079]The FTP and Telnet Configuration page appears.
 
     [bookmark: pgfId-1533080]Step 5 You have two options:
 
      
       
       	 [bookmark: pgfId-1533084]Add a new client profile. Click the add icon (
 
      
 
      [image: ] ) next to 
       FTP Client on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses for the client in the 
       Client Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1533085]You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 1024 characters, and you can configure up to 255 policies, including the default policy. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1601927]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1533092]A new entry appears in the list of FTP clients on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the profile you added.
 
      
       
       	 [bookmark: pgfId-1533093]Modify the settings for an existing client profile. Click the configured address for a profile you have added under  FTP Client on the left side of the page, or click  default .
 
      
 
     
 ) next to the profile you want to remove. 
     
 
     [bookmark: pgfId-1533098]Step 6 Optionally, you can modify any of the following in the Configuration page area:
 
      
       
       	 [bookmark: pgfId-1533099]Optionally, modify the address or addresses listed in the  Networks field and click any other area of the page.
 
      
 
     
 
     [bookmark: pgfId-1533100]The highlighted address updates on the left side of the page.
 
     [bookmark: pgfId-1579159]Note that you cannot modify the setting for Network in the default profile. The default profile applies to all client hosts on your network that are not identified in another profile.
 
      
       
       	 [bookmark: pgfId-1579162][bookmark: 22373]Specify, in bytes, the maximum length of responses from the FTP client in the  Max Response Length field. 
 
       	 [bookmark: pgfId-1533104]To detect FTP bounce attacks, select  Detect FTP Bounce attempts .
 
      
 
     
 
     [bookmark: pgfId-1533105]The FTP/Telnet decoder detects when an FTP PORT command is issued and the specified host does not match the specified host of the client. 
 
      
       
       	 [bookmark: pgfId-1533106]To configure a list of additional hosts and ports where FTP PORT commands should not be treated as FTP bounce attacks, specify each host (or network in CIDR format) followed by a colon (:) and the port or port range in the  Allow FTP Bounce to field. To enter a range of ports for a host, separate the beginning port in the range and the final port in the range with a dash (-). You can enter multiple hosts by separating the entries for the hosts with a comma.
 
      
 
     
 
     [bookmark: pgfId-1533107]For example, to permit FTP PORT commands directed to the host 192.168.1.1 at port 21 and commands directed to the host 192.168.1.2 at any of the ports from 22 to 1024, type:
 
      
      [bookmark: pgfId-1533108]192.168.1.1:21, 192.168.1.2:22-1024 
     
 
     [bookmark: pgfId-1533114]For information on using CIDR notation and prefix lengths in the FireSIGHT System, see IP Address Conventions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533116]Note To specify multiple individual ports for a host, you must repeat the host IP address for each port definition. For example, to specify the ports 22 and 25 on 192.168.1.1, type 192.168.1.1:22, 192.168.1.1:25.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-1533117]To detect when telnet commands are used over the FTP command channel, select  Detect Telnet Escape Codes within FTP Commands .
 
       	 [bookmark: pgfId-1533118]To ignore telnet character and line erase commands when normalizing FTP traffic, select  Ignore Erase Commands During Normalization .
 
      
 
     
 
     [bookmark: pgfId-1533121]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533125]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1533130][bookmark: 52545]De[bookmark: HTTPInspection]cod[bookmark: marker-1533129]ing HTTP Traffic
 
    [bookmark: pgfId-1533138]License: Protection
 
    [bookmark: pgfId-1533140]The HTTP Inspect preprocessor is responsible for:
 
     
     	 [bookmark: pgfId-1533141]decoding and normalizing HTTP requests sent to and HTTP responses received from web servers on your network
 
     	 [bookmark: pgfId-1533142]separating messages sent to web servers into URI, non-cookie header, cookie header, method, and message body components to improve performance of HTTP-related intrusion rules
 
     	 [bookmark: pgfId-1533143]separating messages received from web servers into status code, status message, non-set-cookie header, cookie header, and response body components to improve performance of HTTP-related intrusion rules
 
     	 [bookmark: pgfId-1533144]detecting possible URI-encoding attacks
 
     	 [bookmark: pgfId-1533145]making the normalized data available for additional rule processing
 
    
 
    [bookmark: pgfId-1533146]HTTP traffic can be encoded in a variety of formats, making it difficult for rules to appropriately inspect. HTTP Inspect decodes 14 types of encoding, ensuring that your HTTP traffic gets the best inspection possible.
 
    [bookmark: pgfId-1533147]You can configure HTTP Inspect options globally, on a single server, or for a list of servers. 
 
    [bookmark: pgfId-1533148]Note the following when using the HTTP Inspect preprocessor:
 
     
     	 [bookmark: pgfId-1533149]The preprocessor engine performs HTTP normalization  statelessly . That is, it normalizes HTTP strings on a packet-by-packet basis, and can only process HTTP strings that have been reassembled by the TCP stream preprocessor. 
 
     	 [bookmark: pgfId-1533157]You must enable HTTP preprocessor rules, which have a generator ID (GID) of 119, if you want these rules to generate events. See Setting Rule States for more information.
 
    
 
    [bookmark: pgfId-1533165]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1533169]Selecting Global HTTP Normalization Options
 
     	 [bookmark: pgfId-1533173]Configuring Global HTTP Configuration Options
 
     	 [bookmark: pgfId-1533177]Selecting Server-Level HTTP Normalization Options
 
     	 [bookmark: pgfId-1533181]Selecting Server-Level HTTP Normalization Encoding Options
 
     	 [bookmark: pgfId-1533185]Configuring HTTP Server Options
 
     	 [bookmark: pgfId-1533189]Enabling Additional HTTP Inspect Preprocessor Rules
 
    
 
     
      [bookmark: pgfId-1533192][bookmark: 81629]Selecting Glob[bookmark: marker-1533191]al HTTP Normalization Options
 
     [bookmark: pgfId-1533199]License: Protection
 
     [bookmark: pgfId-1533201]The global HTTP options provided for the HTTP Inspect preprocessor control how the preprocessor functions. Use these options to enable or disable HTTP normalization when ports not specified as web server ports receive HTTP traffic.
 
     [bookmark: pgfId-1533202]Note the following:
 
      
      	 [bookmark: pgfId-1533203]If you enable  Unlimited Decompression , the  Maximum Compressed Data Depth and  Maximum Decompressed Data Depth options are automatically set to 65535 when you commit your changes. See Selecting Server-Level HTTP Normalization Options for more information.
 
      	 [bookmark: pgfId-1533207]If the values for the  Maximum Compressed Data Depth and  Maximum Decompressed Data Depth options are different in an intrusion policy associated with the default action of an access control policy and intrusion policies associated with access control rules, the highest value is used. 
 
     
 
     [bookmark: pgfId-1533214]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533215]Detect Anomalous HTTP Servers
 
     [bookmark: pgfId-1533216]Detects HTTP traffic sent to or received by ports not specified as web server ports.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533217]Note If you turn this option on, be make to list all ports that do receive HTTP traffic in a server profile on the HTTP Configuration page. If you do not, and you enable this option and the accompanying preprocessor rule, normal traffic to and from the server will generate events. The default server profile contains all ports normally used for HTTP traffic, but if you modified that profile, you may need to add those ports to another profile to prevent events from being generated.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533221]You can enable rule 120:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533222]Detect HTTP Proxy Servers
 
     [bookmark: pgfId-1533223]Detects HTTP traffic using proxy servers not defined by the Allow HTTP Proxy Use option.
 
     [bookmark: pgfId-1533227]You can enable rule 119:17 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1571799]Maximum Compressed Data Depth
 
     [bookmark: pgfId-1571800]Sets the maximum size of compressed data to decompress when Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled. You can specify from 1 to 65535 bytes. 
 
     [bookmark: pgfId-1533230]Maximum Decompressed Data Depth
 
     [bookmark: pgfId-1533231]Sets the maximum size of the normalized decompressed data when Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled. You can specify from 1 to 65535 bytes. 
 
    
 
     
      [bookmark: pgfId-1533234][bookmark: 66260]Configuring Glob[bookmark: marker-1533233]al HTTP Configuration Options
 
     [bookmark: pgfId-1533241]License: Protection
 
     [bookmark: pgfId-1533243]You can configure detection of HTTP traffic to non-standard ports and on HTTP traffic using proxy servers. For more information on global HTTP configuration options, see Selecting Global HTTP Normalization Options.
 
     [bookmark: pgfId-1533247]To configure global HTTP configuration options:
 
     [bookmark: pgfId-1533251]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609058]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572882]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572887]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572891]The Policy Information page appears.
 
     [bookmark: pgfId-1572892]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572893]The Settings page appears.
 
     [bookmark: pgfId-1533266]Step 4 You have two choices, depending on whether HTTP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1533267]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1533268]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1533269]The HTTP Configuration page appears.
 
     [bookmark: pgfId-1533272]Step 5 You can modify any of the global options described in Selecting Global HTTP Normalization Options.
 
     [bookmark: pgfId-1533276]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533280]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533283][bookmark: 47617]Selecting Server-[bookmark: marker-1533282]Level HTTP Normalization Options
 
     [bookmark: pgfId-1533290]License: Protection
 
     [bookmark: pgfId-1533292]You can set server-level options for each server you monitor, globally for all servers, or for a list of servers. Additionally, you can use a predefined server profile to set these options, or you can set them individually to meet the needs of your environment. Use these options, or one of the default profiles that set these options, to specify the HTTP server ports whose traffic you want to normalize, the amount of server response payload you want to normalize, and the types of encoding you want to normalize.
 
     [bookmark: pgfId-1533293]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533294]Networks
 
     [bookmark: pgfId-1533295]Use this option to specify the IP address of one or more servers. You can specify a single IP address or address block, or a comma-separated list comprised of either or both. 
 
     [bookmark: pgfId-1533296]In addition to a limit of up to 255 total profiles, including the default profile, you can include up to 496 characters, or approximately 26 entries, in an HTTP server list, and specify a total of 256 address entries for all server profiles. For information on using IPv4 CIDR notation and IPv6 prefix lengths in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1533303]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1600940]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1533304]Ports
 
     [bookmark: pgfId-1533305]The ports whose HTTP traffic the preprocessor engine normalizes. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1533310]Oversize Dir Length
 
     [bookmark: pgfId-1533311]Detects URL directories longer than the specified value.
 
     [bookmark: pgfId-1533315]You can enable rule 119:15 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533316]Client Flow Depth
 
     [bookmark: pgfId-1533317]Specifies the number of bytes for rules to inspect in raw HTTP packets, including header and payload data, in client-side HTTP traffic defined in Ports. Client flow depth does not apply when HTTP content rule options within a rule inspect specific parts of a request message. See HTTP Content Options for more information.
 
     [bookmark: pgfId-1533324]You can specify a value from -1 to 1460. Cisco recommends that you set client flow depth to its maximum value. Specify any of the following:
 
     [bookmark: pgfId-1533325] – From 1 to 1460 inspects the specified number of bytes in the first packet. If the first packet contains fewer bytes than specified, inspect the entire packet. Note that the specified value applies to both segmented and reassembled packets.
 
     [bookmark: pgfId-1533326]Note also that a value of 300 typically eliminates inspection of large HTTP Cookies that appear at the end of many client request headers.
 
     [bookmark: pgfId-1533327] – 0 inspects all client-side traffic, including multiple packets in a session and exceeding the 1460 byte limit if necessary. Note that this value is likely to affect performance.
 
     [bookmark: pgfId-1533328] – -1 ignores all client-side traffic. 
 
     [bookmark: pgfId-1533329]Server Flow Depth
 
     [bookmark: pgfId-1533330]Specifies the number of bytes for rules to inspect in raw HTTP packets in server-side HTTP traffic specified by Ports. Inspection includes the raw header and payload when Inspect HTTP Responses disabled and only the raw response body when Inspect HTTP Response is enabled.
 
     [bookmark: pgfId-1533331]Server flow depth specifies the number of bytes of raw server response data in a session for rules to inspect in server-side HTTP traffic defined in Ports. You can use this option to balance performance and the level of inspection of HTTP server response data. Server flow depth does not apply when HTTP content options within a rule inspect specific parts of a response message. See HTTP Content Options for more information.
 
     [bookmark: pgfId-1533335]Unlike client flow depth, server flow depth specifies the number of bytes per HTTP response, not per HTTP request packet, for rules to inspect.
 
     [bookmark: pgfId-1533339]You can specify a value from -1 to 65535. Cisco recommends that you set the server flow depth to its maximum value. You can specify any of the following:
 
     [bookmark: pgfId-1533340] – From 1 to 65535:
 
     [bookmark: pgfId-1533341]When Inspect HTTP Responses is enabled, inspects only the raw HTTP response body, and not raw HTTP headers; also inspects decompressed data when Inspect Compressed Data is enabled.
 
     [bookmark: pgfId-1533342]When Inspect HTTP Responses is disabled, inspects the raw packet header and payload.
 
     [bookmark: pgfId-1533343]If the session includes fewer response bytes than specified, rules fully inspect all response packets in a given session, across multiple packets as needed. If the session includes more response bytes than specified, rules inspect only the specified number of bytes for that session, across multiple packets as needed.
 
     [bookmark: pgfId-1533344]Note that a small flow depth value may cause false negatives from rules that target server-side traffic defined in Ports. Most of these rules target either the HTTP header or content that is likely to be in the first hundred or so bytes of non-header data. Headers are usually under 300 bytes long, but header size may vary.
 
     [bookmark: pgfId-1533345]Note also that the specified value applies to both segmented and reassembled packets.
 
     [bookmark: pgfId-1533346] – 0 inspects the entire packet for all HTTP server-side traffic defined in Ports, including response data in a session that exceeds 65535 bytes.
 
     [bookmark: pgfId-1533347]Note that this value is likely to affect performance.
 
     [bookmark: pgfId-1533348] – -1:
 
     [bookmark: pgfId-1533349]When Inspect HTTP Responses is enabled, inspects only raw HTTP headers and not the raw HTTP response body.
 
     [bookmark: pgfId-1533350]When Inspect HTTP Responses is disabled, ignores all server-side traffic defined in Ports.
 
     [bookmark: pgfId-1533351]Maximum Header Length
 
     [bookmark: pgfId-1533352]Detects a header field longer than the specified maximum number of bytes in an HTTP request; also in HTTP responses when Inspect HTTP Responses is enabled. The value of 0 disables this option. Specify a value from 1 to 65535 to enable it.
 
     [bookmark: pgfId-1533356]You can enable rule 119:19 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533357]Maximum Number of Headers
 
     [bookmark: pgfId-1533358]Detects when the number of headers exceeds this setting in an HTTP request. Specify a value from 1 to 1024 to enable it.
 
     [bookmark: pgfId-1533362]You can enable rule 119:20 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533363]Maximum Number of Spaces
 
     [bookmark: pgfId-1533364]Detects when the number of white spaces in a folded line equals or exceeds this setting in an HTTP request. A value of 0 disables this option. Specify a value from 1 to 65535 to enable it.
 
     [bookmark: pgfId-1533368]You can enable rule 119:26 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533369]HTTP Client Body Extraction Depth
 
     [bookmark: pgfId-1533370]Specifies the number of bytes to extract from the message body of an HTTP client request. You can use an intrusion rule to inspect the extracted data by selecting the content or protected_content keyword HTTP Client Body option. See HTTP Content Options for more information.
 
     [bookmark: pgfId-1533374]Specify a value from -1 to 65495. Specify -1 to ignore the client body. Specify 0 to extract the entire client body. Note that identifying specific bytes to extract can improve system performance. Note also that you must specify a value from 0 to 65495 for the HTTP Client Body option to function in an intrusion rule.
 
     [bookmark: pgfId-1533375]Small Chunk Size
 
     [bookmark: pgfId-1533376]Specifies the maximum number of bytes at which a chunk is considered small. Specify a value of 1 to 255. A value of 0 disables detection of anomalous consecutive small segments. See the Consecutive Small Chunks option for more information.
 
     [bookmark: pgfId-1533377]Consecutive Small Chunks
 
     [bookmark: pgfId-1533378]Specifies how many consecutive small chunks represent an abnormally large number in client or server traffic that uses chunked transfer encoding. The Small Chunk Size option specifies the maximum size of a small chunk.
 
     [bookmark: pgfId-1533379]For example, set Small Chunk Size to 10 and Consecutive Small Chunks to 5 to detect 5 consecutive chunks of 10 bytes or less.
 
     [bookmark: pgfId-1533380]You can enable preprocessor rule 119:27 to trigger events on excessive small chunks in client traffic, and rule 120:7 in server traffic. When Small Chunk Size is enabled and this option is set to 0 or 1, enabling these rules would trigger an event on every chunk of the specified size or less. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533384]HTTP Methods
 
     [bookmark: pgfId-1533385]Specifies HTTP request methods in addition to GET and POST that you expect the system to encounter in traffic. Use a comma to separate multiple values.
 
     [bookmark: pgfId-1533386]Intrusion rules use the content or protected_content keyword with the HTTP Method argument to search for content in HTTP methods. See HTTP Content Options. You can enable rule 119:31 to generate events when a method other than GET, POST, or a method configured for this option is encountered in traffic.
 
     [bookmark: pgfId-1533390]No Alerts
 
     [bookmark: pgfId-1533391]Disables intrusion events when accompanying preprocessor rules are enabled.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533398]Note This option does not disable HTTP standard text rules and shared object rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533399]Normalize HTTP Headers
 
     [bookmark: pgfId-1533400]When Inspect HTTP Responses is enabled, enables normalization of non-cookie data in request and response headers. When Inspect HTTP Responses is not enabled, enables normalization of the entire HTTP header, including cookies, in request and response headers.
 
     [bookmark: pgfId-1533401]Inspect HTTP Cookies
 
     [bookmark: pgfId-1533402]Enables extraction of cookies from HTTP request headers. Also enables extraction of set-cookie data from response headers when Inspect HTTP Responses is enabled. Disabling this option when cookie extraction is not required can improve performance.
 
     [bookmark: pgfId-1533403]Note that the Cookie: and Set-Cookie: header names, leading spaces on the header line, and the CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
     [bookmark: pgfId-1533404]Normalize Cookies in HTTP headers
 
     [bookmark: pgfId-1533405]Enables normalization of cookies in HTTP request headers. When Inspect HTTP Responses is enabled, also enables normalization of set-cookie data in response headers. You must select Inspect HTTP Cookies before selecting this options.
 
     [bookmark: pgfId-1533406]Allow HTTP Proxy Use
 
     [bookmark: pgfId-1533407]Allows the monitored web server to be used as an HTTP proxy. This option is used only in the inspection of HTTP requests.
 
     [bookmark: pgfId-1533408]Inspect URI Only
 
     [bookmark: pgfId-1533409]Inspects only the URI portion of the normalized HTTP request packet.
 
     [bookmark: pgfId-1533410]Inspect HTTP Responses
 
     [bookmark: pgfId-1533411]Enables extended inspection of HTTP responses so, in addition to decoding and normalizing HTTP request messages, the preprocessor extracts response fields for inspection by the rules engine. Enabling this option causes the system to extract the response header, body, status code, and so on, and also extracts set-cookie data when Inspect HTTP Cookies is enabled. For more information, see HTTP Content Options, Generating Events on the HTTP Encoding Type and Location, and Pointing to a Specific Payload Type.
 
     [bookmark: pgfId-1533423]You can enable rules 120:2 and 120:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533425]Normalize UTF Encodings to UTF-8
 
     [bookmark: pgfId-1533426]When Inspect HTTP Responses is enabled, detects UTF-16LE, UTF-16BE, UTF-32LE, and UTF32-BE encodings in HTTP responses and normalizes them to UTF-8.
 
     [bookmark: pgfId-1533430]You can enable rule 120:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533431][bookmark: 60439]Inspect Compressed Data
 
     [bookmark: pgfId-1564917]When Inspect HTTP Responses is enabled, enables decompression of gzip and deflate-compatible compressed data in the HTTP response body, and inspection of the normalized decompressed data. The system inspects chunked and non-chunked HTTP response data. The system inspects decompressed data packet by packet across multiple packets as needed; that is, the system does not combine the decompressed data from different packets for inspection. Decompression ends when Maximum Compressed Data Depth, Maximum Decompressed Data Depth, or the end of the compressed data is reached. Inspection of decompressed data ends when Server Flow Depth is reached unless you also select Unlimited Decompression. You can use the file_data rule keyword to inspect decompressed data; see Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1564591]Unlimited Decompression
 
     [bookmark: pgfId-1564592]When Inspect Compressed Data (and, optionally, Decompress SWF File (LZMA), Decompress SWF File (Deflate), or Decompress PDF File (Deflate)) is enabled, overrides Maximum Decompressed Data Depth across multiple packets; that is, this option enables unlimited decompression across multiple packets. Note that enabling this option does not affect Maximum Compressed Data Depth or Maximum Decompressed Data Depth within a single packet. Note also that enabling this option sets Maximum Compressed Data Depth and Maximum Decompressed Data Depth to 65535 when you commit your changes. See Selecting Global HTTP Normalization Options.
 
     [bookmark: pgfId-1533441]Normalize Javascript
 
     [bookmark: pgfId-1533442]When Inspect HTTP Responses is enabled, enables detection and normalization of Javascript within the HTTP response body. The preprocessor normalizes obfuscated Javascript data such as the unescape and decodeURI functions and the String.fromCharCode method. The preprocessor normalizes the following encodings within the unescape, decodeURI, and decodeURIComponent functions:
 
     [bookmark: pgfId-1533443] – %XX
 
     [bookmark: pgfId-1533444] – %uXXXX
 
     [bookmark: pgfId-1533445] – 0xXX
 
     [bookmark: pgfId-1533446] – \xXX
 
     [bookmark: pgfId-1533447] – \uXXXX
 
     [bookmark: pgfId-1533448]The preprocessor detects consecutive white spaces and normalizes them into a single space. When this option is enabled, a configuration field allows you to specify the maximum number of consecutive white spaces to permit in obfuscated Javascript data. You can enter a value from 1 to 65535. The value 0 disables event generation, regardless of whether the preprocessor rule (120:10) associated with this field is enabled.
 
     [bookmark: pgfId-1533449]The preprocessor also normalizes the Javascript plus (+) operator and concatenates strings using the operator.
 
     [bookmark: pgfId-1533450]You can use the file_data keyword to point intrusion rules to the normalized Javascript data. See Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1533454]You can enable rules 120:9, 120:10, and 120:11 to generate events for this option, as follows:
 
     [bookmark: pgfId-1533479]
 
      
       
        
        [bookmark: pgfId-1533460]Table 27-6 Normalize Javascript Option Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1533464]This rule... 
          
  
         	 
           
           [bookmark: pgfId-1533466]Triggers an event when... 
          
  
        
 
         
         	[bookmark: pgfId-1533468]120:9
  
         	[bookmark: pgfId-1533470]the obfuscation level within the preprocessor is greater than or equal to 2.
  
        
 
         
         	[bookmark: pgfId-1533472]120:10
  
         	[bookmark: pgfId-1533474]the number of consecutive white spaces in the Javascript obfuscated data is greater than or equal to the value configured for the maximum number of consecutive white spaces allowed.
  
        
 
         
         	[bookmark: pgfId-1533476]120:11
  
         	[bookmark: pgfId-1533478]escaped or encoded data includes more than one type of encoding.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1533483]See Setting Rule States for more information.
 
     [bookmark: pgfId-1533484][bookmark: 57591]Decompress SWF File (LZMA) and Decompress SWF File (Deflate)
 
     [bookmark: pgfId-1594508]When HTTP Inspect Responses is enabled, these options decompress the compressed portions of files located within the HTTP response body of HTTP requests. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1594509]Note You can only decompress the compressed portions of files found in HTTP GET responses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1594501] – Decompress SWF File (LZMA) decompresses the LZMA-compatible compressed portions of Adobe ShockWave Flash (.swf) files
 
     [bookmark: pgfId-1583223] – Decompress SWF File (Deflate) decompresses the deflate-compatible compressed portions of Adobe ShockWave Flash (.swf) files
 
     [bookmark: pgfId-1583123]Decompression ends when Maximum Compressed Data Depth, Maximum Decompressed Data Depth, or the end of the compressed data is reached. Inspection of decompressed data ends when Server Flow Depth is reached unless you also select Unlimited Decompression. You can use the file_data rule keyword to inspect decompressed data; see Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1596862]You can enable rules 120:12 and 120:13 to generate events for this option, as follows:
 
     [bookmark: pgfId-1592971]
 
      
       
        
        [bookmark: pgfId-1592952]Table 27-7 Decompress SWF File Option Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1592956]This rule... 
          
  
         	 
           
           [bookmark: pgfId-1592958]Triggers an event when... 
          
  
        
 
         
         	[bookmark: pgfId-1592960]120:12
  
         	[bookmark: pgfId-1592962]deflate file decompression fails.
  
        
 
         
         	[bookmark: pgfId-1592964]120:13
  
         	[bookmark: pgfId-1592966]LZMA file decompression fails.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1591991]Decompress PDF File (Deflate)
 
     [bookmark: pgfId-1595024]When HTTP Inspect Responses is enabled, Decompress PDF File (Deflate) decompresses the deflate-compatible compressed portions of Portable Document Format (.pdf) files located within the HTTP response body of HTTP requests. The system can only decompress PDF files with the /FlateDecode stream filter. Other stream filters (including /FlateDecode /FlateDecode) are unsupported.
 
      
       
     
 
     
 
     [bookmark: pgfId-1595025]Note You can only decompress the compressed portions of files found in HTTP GET responses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1591996]Decompression ends when Maximum Compressed Data Depth, Maximum Decompressed Data Depth, or the end of the compressed data is reached. Inspection of decompressed data ends when Server Flow Depth is reached unless you also select Unlimited Decompression. You can use the file_data rule keyword to inspect decompressed data; see Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1596895]You can enable rules 120:14, 120:15, 120:16, and 120:17 to generate events for this option, as follows:
 
     [bookmark: pgfId-1593313]
 
      
       
        
        [bookmark: pgfId-1593294]Table 27-8 Decompress PDF File (Deflate) Option Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1593298]This rule... 
          
  
         	 
           
           [bookmark: pgfId-1593300]Triggers an event when... 
          
  
        
 
         
         	[bookmark: pgfId-1593302]120:14
  
         	[bookmark: pgfId-1593304]file decompression fails.
  
        
 
         
         	[bookmark: pgfId-1593306]120:15
  
         	[bookmark: pgfId-1593308]file decompression fails due to an unsupported compression type.
  
        
 
         
         	[bookmark: pgfId-1593310]120:16
  
         	[bookmark: pgfId-1593312]file decompression fails due to an unsupported PDF stream filter.
  
        
 
         
         	[bookmark: pgfId-1594039]120:17
  
         	[bookmark: pgfId-1594041]file parsing fails.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1563532]Extract Original Client IP Address
 
     [bookmark: pgfId-1533485]Enables extraction of the original client IP address from the X-Forwarded-For (XFF), True-Client-IP, or custom-defined HTTP header. You can display the extracted original client IP address in the intrusion events table view. See Understanding Intrusion Events for more information.
 
     [bookmark: pgfId-1533491]You can enable rules 119:23, 119:29 and 119:30 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1537511]XFF Header Priority
 
     [bookmark: pgfId-1537735]When Extract Original Client IP Address is enabled, specifies the order in which the system processes original client IP HTTP headers. If, on your monitored network, you expect to encounter original client IP headers other than X-Forwarded-For (XFF) or True-Client-IP, you can click Add to add additional header names to the priority list. You can then use the up and down arrow icons beside each header type to adjust its priority. Note that if multiple XFF headers appear in an HTTP request, the system processes only the header with the highest priority.
 
     [bookmark: pgfId-1537736]Log URI
 
     [bookmark: pgfId-1533494]Enables extraction of the raw URI, if present, from HTTP request packets and associates the URI with all intrusion events generated for the session.
 
     [bookmark: pgfId-1533495]When this option is enabled, you can display the first fifty characters of the extracted URI in the HTTP URI column of the intrusion events table view. You can display the complete URI, up to 2048 bytes, in the packet view. See Understanding Intrusion Events and Viewing Event Information for more information.
 
     [bookmark: pgfId-1533502]Log Hostname
 
     [bookmark: pgfId-1533503]Enables extraction of the host name, if present, from the HTTP request Host header and associates the host name with all intrusion events generated for the session. When multiple Host headers are present, extracts the host name from the first header.
 
     [bookmark: pgfId-1533504]When this option is enabled, you can display the first fifty characters of the extracted host name in the HTTP Hostname column of the intrusion events table view. You can display the complete host name, up to 256 bytes, in the packet view. See Understanding Intrusion Events and Viewing Event Information for more information.
 
     [bookmark: pgfId-1533514]You can enable rule 119:25 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533515]Note that when the preprocessor and rule 119:24 are enabled, the preprocessor generates an intrusion event if it detects multiple Host headers in an HTTP request, regardless of the setting for this option. See Enabling Additional HTTP Inspect Preprocessor Rules for more information.
 
     [bookmark: pgfId-1533519]Profile
 
     [bookmark: pgfId-1533520]Specifies the types of encoding that are normalized for HTTP traffic. The system provides a default profile appropriate for most servers, default profiles for Apache servers and IIS servers, and custom default settings that you can tailor to meet the needs of your monitored traffic. See Selecting Server-Level HTTP Normalization Encoding Options for more information.
 
    
 
     
      [bookmark: pgfId-1533526][bookmark: 38097]Selecting Server-[bookmark: marker-1533525]Level HTTP Normalization Encoding Options
 
     [bookmark: pgfId-1533533]License: Protection
 
     [bookmark: pgfId-1533535]You can select server-level HTTP normalization options to specify the types of encoding that are normalized for HTTP traffic, and to cause the system to generate events against traffic containing this type of encoding. 
 
     [bookmark: pgfId-1533537]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533539]A[bookmark: marker-1533538]SCII Encoding
 
     [bookmark: pgfId-1533540]Decodes encoded ASCII characters and specifies whether the rules engine generates an event on ASCII-encoded URIs.
 
     [bookmark: pgfId-1533544]You can enable rule 119:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533546][bookmark: marker-1533545]UTF-8 Encoding
 
     [bookmark: pgfId-1533547]Decodes standard UTF-8 Unicode sequences in the URI.
 
     [bookmark: pgfId-1533551]You can enable rule 119:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533553][bookmark: marker-1533552]Microsoft %U Encoding
 
     [bookmark: pgfId-1533554]Decodes the IIS %u encoding scheme that uses %u followed by four characters where the 4 characters are a hex encoded value that correlates to an IIS Unicode codepoint.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533558]Tip Legitimate clients rarely use %u encodings, so Cisco recommends decoding HTTP traffic encoded with %u encodings.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533562]You can enable rule 119:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533564]B[bookmark: marker-1533563]are Byte UTF-8 Encoding
 
     [bookmark: pgfId-1533565]Decodes bare byte encoding, which uses non-ASCII characters as valid values in decoding UTF-8 values.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533566]Tip Bare byte encoding allows the user to emulate an IIS server and interpret non-standard encodings correctly. Cisco recommends enabling this option because no legitimate clients encode UTF-8 this way.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533573]You can enable rule 119:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533575][bookmark: marker-1533574]Microsoft IIS Encoding
 
     [bookmark: pgfId-1533576]Decodes using Unicode codepoint mapping.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533580]Tip Cisco recommends enabling this option, because it is seen mainly in attacks and evasion attempts.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533584]You can enable rule 119:7 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533586]Do[bookmark: marker-1533585]uble Encoding
 
     [bookmark: pgfId-1533587]Decodes IIS double encoded traffic by making two passes through the request URI performing decodes in each one. Cisco recommends enabling this option because it is usually found only in attack scenarios.
 
     [bookmark: pgfId-1533594]You can enable rule 119:2 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533596]M[bookmark: marker-1533595]ulti-Slash Obfuscation
 
     [bookmark: pgfId-1533597]Normalizes multiple slashes in a row into a single slash.
 
     [bookmark: pgfId-1533601]You can enable rule 119:8 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533603][bookmark: marker-1533602]IIS Backslash Obfuscation
 
     [bookmark: pgfId-1533604]Normalizes backslashes to forward slashes.
 
     [bookmark: pgfId-1533608]You can enable rule 119:9 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533610]Dir[bookmark: marker-1533609]ectory Traversal
 
     [bookmark: pgfId-1533611]Normalizes directory traversals and self-referential directories. If you enable the accompanying preprocessor rules to generate events against this type of traffic, it may generate false positives because some web sites refer to files using directory traversals.
 
     [bookmark: pgfId-1533614]You can enable rules 119:10 and 119:11 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533617]Ta[bookmark: marker-1533616]b Obfuscation
 
     [bookmark: pgfId-1533618]Normalizes the non-RFC standard of using a tab for a space delimiter. Apache and other non-IIS web servers use the tab character (0x09) as a delimiter in URLs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533619]Note Regardless of the configuration for this option, the HTTP Inspect preprocessor treats a tab as white space if a space character (0x20) precedes it.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533623]You can enable rule 119:12 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533625]Inva[bookmark: marker-1533624]lid RFC Delimiter
 
     [bookmark: pgfId-1533626]Normalizes line breaks (\n) in URI data.
 
     [bookmark: pgfId-1533630]You can enable rule 119:13 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533632]We[bookmark: marker-1533631]broot Directory Traversal
 
     [bookmark: pgfId-1533633]Detects directory traversals that traverse past the initial directory in the URL.
 
     [bookmark: pgfId-1533637]You can enable rule 119:18 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533639]Tab UR[bookmark: marker-1533638]I Delimiter
 
     [bookmark: pgfId-1533640]Turns on the use of the tab character (0x09) as a delimiter for a URI. Apache, newer versions of IIS, and some other web servers use the tab character as a delimiter in URLs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533641]Note Regardless of the configuration for this option, the HTTP Inspect preprocessor treats a tab as white space if a space character (0x20) precedes it.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533643]N[bookmark: marker-1533642]on-RFC characters
 
     [bookmark: pgfId-1533644]Detects the non-RFC character list you add in the corresponding field when it appears within incoming or outgoing URI data. When modifying this field, use the hexadecimal format that represents the byte character. If and when you configure this option, set the value with care. Using a character that is very common may overwhelm you with events.
 
     [bookmark: pgfId-1533648]You can enable rule 119:14 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533650]M[bookmark: marker-1533649]ax Chunk Encoding Size
 
     [bookmark: pgfId-1533651]Detects abnormally large chunk sizes in URI data. 
 
     [bookmark: pgfId-1533654]You can enable rules 119:16 and 119:22 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533657]Dis[bookmark: marker-1533656]able Pipeline Decoding
 
     [bookmark: pgfId-1533658]Disables HTTP decoding for pipelined requests. When this option is disabled, performance is enhanced because HTTP requests waiting in the pipeline are not decoded or analyzed, and are only inspected using generic pattern matching.
 
     [bookmark: pgfId-1533660]Non-Strict [bookmark: marker-1533659]URI Parsing
 
     [bookmark: pgfId-1533661]Enables non-strict URI parsing. Use this option only on servers that will accept non-standard URIs in the format "GET /index.html abc xo qr \n". Using this option, the decoder assumes that the URI is between the first and second space, even if there is no valid HTTP identifier after the second space.
 
     [bookmark: pgfId-1533663]Extende[bookmark: marker-1533662]d ASCII Encoding
 
     [bookmark: pgfId-1533664]Enables parsing of extended ASCII characters in an HTTP request URI. Note that this option is available in custom server profiles only, and not in the default profiles provided for Apache, IIS, or all servers.
 
    
 
     
      [bookmark: pgfId-1533667][bookmark: 15877]Configurin[bookmark: marker-1533666]g HTTP Server Options
 
     [bookmark: pgfId-1533674]License: Protection
 
     [bookmark: pgfId-1533676]Use the following procedure to configure HTTP server options. For more information on the HTTP server options, see Selecting Server-Level HTTP Normalization Options and Selecting Server-Level HTTP Normalization Encoding Options.
 
     [bookmark: pgfId-1533683]To configure server-level HTTP configuration options:
 
     [bookmark: pgfId-1533687]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609071]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572907]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572912]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572916]The Policy Information page appears.
 
     [bookmark: pgfId-1572917]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572918]The Settings page appears.
 
     [bookmark: pgfId-1533702]Step 4 You have two choices, depending on whether HTTP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1533703]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1533704]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1533705]The HTTP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1533709]Step 5 You have two options:
 
      
       
       	 [bookmark: pgfId-1533713]Add a new server profile. Click the add icon (
 
      
 
      [image: ] ) next to 
       Servers on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses for the client in the 
       Server Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1601971]You can specify a single IP address or address block, or a comma-separated list of either or both. You can include up to 496 characters in a list, specify a total of 256 address entries for all server profiles, and create a total of 255 profiles including the default profile. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1602000]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1601978]A new entry appears in the list of servers on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the profile you added.
 
      
       
       	 [bookmark: pgfId-1533722]Modify the settings for an existing profile. Click the configured address for a profile you have added under  Servers on the left side of the page, or click  default .
 
      
 
     
 ) next to the profile you want to remove. 
     
 
     [bookmark: pgfId-1533727]Step 6 Optionally, modify the address or addresses listed in the Networks field and click any other area of the page.
 
     [bookmark: pgfId-1533728]The highlighted address updates on the left side of the page.
 
     [bookmark: pgfId-1600990]Note that you cannot modify the setting for Networks in the default profile. The default profile applies to all servers on your network that are not identified in another profile.
 
     [bookmark: pgfId-1600992]Step 7 In the Ports field, list the ports whose traffic you want to inspect with HTTP Inspect. Separate multiple ports with commas.
 
     [bookmark: pgfId-1533733]Step 8 You can modify any of the other options described in Selecting Server-Level HTTP Normalization Options.
 
     [bookmark: pgfId-1533735]Step 9 Select a server profile as follows:
 
      
       
       	 [bookmark: pgfId-1533738]Select  Custom to create your own server profile (see Selecting Server-Level HTTP Normalization Encoding Options for more information).
 
       	 [bookmark: pgfId-1533740]Select  All to use the standard default profile, appropriate for all servers.
 
       	 [bookmark: pgfId-1533741]Select  IIS to use the default IIS profile.
 
       	 [bookmark: pgfId-1533742]Select  Apache to use the default Apache profile.
 
      
 
     
 
     [bookmark: pgfId-1533743]Step 10 If you selected Custom, the custom options appear.
 
     [bookmark: pgfId-1533744]Step 11 Configure the HTTP decoding options you want in your profile.
 
     [bookmark: pgfId-1533748]See Selecting Server-Level HTTP Normalization Options for details on available normalization options.
 
     [bookmark: pgfId-1533751]Step 12 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533755]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1533758][bookmark: 58835]Enabling Additional HTTP [bookmark: marker-1533757]Inspect Preprocessor Rules
 
     [bookmark: pgfId-1533765]License: Protection
 
     [bookmark: pgfId-1533767]You can enable the rules in the Preprocessor Rule GID:SID column of the following table to generate events for HTTP Inspect preprocessor rules that are not associated with specific configuration options. See Setting Rule States for more information.
 
     [bookmark: pgfId-1533815]
 
      
       
        
        [bookmark: pgfId-1533777]Table 27-9 [bookmark: 43151]Additional HTTP Inspect Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1533781]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1533783]Description 
          
  
        
 
         
         	[bookmark: pgfId-1533785]120:5
  
         	[bookmark: pgfId-1533787]Generates an event when UTF-7 encoding is encountered in HTTP response traffic; UTF-7 should only appear where 7-bit parity is required, such as in SMTP traffic.
  
        
 
         
         	[bookmark: pgfId-1533789]119:21
  
         	[bookmark: pgfId-1533791]Generates an event when an HTTP request header has more than one content-length field.
  
        
 
         
         	[bookmark: pgfId-1533793]119:24
  
         	[bookmark: pgfId-1533795]Generates an event when an HTTP request has more than one Host header.
  
        
 
         
         	[bookmark: pgfId-1533797]119:28
120:8
  
         	[bookmark: pgfId-1533799]When enabled, these rules do not generate events.
  
        
 
         
         	[bookmark: pgfId-1533801]119:32
  
         	[bookmark: pgfId-1533803]Generates an event when HTTP version 0.9 is encountered in traffic. Note that the TCP stream configuration must also be enabled. See Using TCP Stream Preprocessing.
  
        
 
         
         	[bookmark: pgfId-1533808]119:33
  
         	[bookmark: pgfId-1533810]Generates an event when an HTTP URI includes an unescaped space.
  
        
 
         
         	[bookmark: pgfId-1533812]119:34
  
         	[bookmark: pgfId-1533814]Generates an event when a TCP connection contains 24 or more pipelined HTTP requests.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1533820][bookmark: 24852]Using the S[bookmark: marker-1533817]un RP[bookmark: marker-1533818]C Pr[bookmark: RPCDecoding]eprocessor
 
    [bookmark: pgfId-1533828]License: Protection
 
    [bookmark: pgfId-1533829]RPC (Remote Procedure Call) normalization takes fragmented RPC records and normalizes them to a single record so the rules engine can inspect the complete record. For example, an attacker may attempt to discover the port where RPC admind runs. Some UNIX hosts use RPC admind to perform remote distributed system tasks. If the host performs weak authentication, a malicious user could take control of remote administration. The standard text rule (generator ID: 1) with the Snort ID (SID) 575 detects this attack by searching for content in specific locations to identify inappropriate portmap GETPORT requests.
 
    [bookmark: pgfId-1533833]Ports
 
    [bookmark: pgfId-1533834]Specify the ports whose traffic you want to normalize. In the interface, list multiple ports separated by commas. Typical RPC ports are 111 and 32771. If your network sends RPC traffic to other ports, consider adding them.
 
    [bookmark: pgfId-1533839]Detect fragmented RPC records
 
    [bookmark: pgfId-1533840]Detects RPC fragmented records.
 
    [bookmark: pgfId-1533843]You can enable rules 106:1 and 106:5 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1533845]Detect multiple records in one packet
 
    [bookmark: pgfId-1533846]Detects more than one RPC request per packet (or reassembled packet).
 
    [bookmark: pgfId-1533850]You can enable rule 106:2 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1533852][bookmark: marker-1533851]Detect fragmented record sums which exceed one fragment
 
    [bookmark: pgfId-1533853]Detects reassembled fragment record lengths that exceed the current packet length.
 
    [bookmark: pgfId-1533857]You can enable rule 106:3 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1533858]Detect single fragment records which exceed the size of one packet
 
    [bookmark: pgfId-1533859]Detects partial records
 
    [bookmark: pgfId-1533863]You can enable rule 106:4 to generate events for this option. See Setting Rule States for more information.
 
     
      [bookmark: pgfId-1533866][bookmark: 40544]Configuring the Sun RPC Preprocessor
 
     [bookmark: pgfId-1533873]License: Protection
 
     [bookmark: pgfId-1533874]You can use the following procedure to configure the Sun RPC preprocessor. For more information on the Sun RPC preprocessor configuration options, see Using the Sun RPC Preprocessor.
 
     [bookmark: pgfId-1533878]To configure the Sun RPC preprocessor:
 
     [bookmark: pgfId-1533882]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609084]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572940]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572945]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572949]The Policy Information page appears.
 
     [bookmark: pgfId-1572950]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572951]The Settings page appears.
 
     [bookmark: pgfId-1533897]Step 4 You have two choices, depending on whether Sun RPC Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1533898]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1533899]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1533900]The Sun RPC Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1533904]Step 5 In the Ports field, type the port numbers where you want to decode RPC traffic. Separate multiple ports with commas. 
 
     [bookmark: pgfId-1533905]Step 6 You can select or clear any of the following detection options on the Sun RPC Configuration page:
 
      
       
       	 [bookmark: pgfId-1533906] Detect fragmented RPC records 
 
       	 [bookmark: pgfId-1533907] Detect multiple records in one packet 
 
       	 [bookmark: pgfId-1533908] Detect fragmented record sums which exceed one packet 
 
       	 [bookmark: pgfId-1533909] Detect single fragment records which exceed the size of one packet 
 
      
 
     
 
     [bookmark: pgfId-1533912]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533916]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1533920][bookmark: 70648]Decoding the Se[bookmark: marker-1533919]ssion Initiation Protocol
 
    [bookmark: pgfId-1533928]License: Protection
 
    [bookmark: pgfId-1533929]The Session Initiation Protocol (SIP) provides call setup, modification, and teardown of one or more sessions for one or more users of such client applications as Internet telephony, multimedia conferencing, instant messaging, online gaming, and file transfer. A method field in each SIP request identifies the purpose of the request, and a Request-URI specifies where to send the request. A status code in each SIP response indicates the outcome of the requested action.
 
    [bookmark: pgfId-1533930]After calls are set up using SIP, the Real-time Transport Protocol (RTP) is responsible for subsequent audio and video communication; this part of the session is sometimes referred to as the call channel, the data channel, or the audio/video data channel. RTP uses the Session Description Protocol (SDP) within the SIP message body for data-channel parameter negotiation, session announcement, and session invitation.
 
    [bookmark: pgfId-1533931]The SIP preprocessor is responsible for:
 
     
     	 [bookmark: pgfId-1533932]decoding and analyzing SIP 2.0 traffic
 
     	 [bookmark: pgfId-1533933]extracting the SIP header and message body, including SDP data when present, and passing the extracted data to the rules engine for further inspection
 
     	 [bookmark: pgfId-1533934]generating events when the following conditions are detected and the corresponding preprocessor rules are enabled: anomalies and known vulnerabilities in SIP packets; out-of-order and invalid call sequences
 
     	 [bookmark: pgfId-1533935]optionally ignoring the call channel
 
    
 
    [bookmark: pgfId-1533936]The preprocessor identifies the RTP channel based on the port identified in the SDP message, which is embedded in the SIP message body, but the preprocessor does not provide RTP protocol inspection.
 
    [bookmark: pgfId-1533937]Note the following when using the SIP preprocessor:
 
     
     	 [bookmark: pgfId-1533938]UDP typically carries media sessions supported by SIP. UDP stream preprocessing provides SIP session tracking for the SIP preprocessor. 
 
     	 [bookmark: pgfId-1533945]SIP rule keywords allow you to point to the SIP packet header or message body and to limit detection to packets for specific SIP methods or status codes. For more information, see SIP Keywords.
 
     	 [bookmark: pgfId-1533949]When enabled, the preprocessor generates no events before sending the extracted data to the rules engine unless you also enable the accompanying rules with generator ID (GID) 140. See Setting Rule States for more information.
 
    
 
    [bookmark: pgfId-1533963]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1533967]Selecting SIP Preprocessor Options
 
     	 [bookmark: pgfId-1533971]Configuring the SIP Preprocessor
 
     	 [bookmark: pgfId-1533975]Enabling Additional SIP Preprocessor Rules
 
    
 
     
      [bookmark: pgfId-1533978][bookmark: 28900]Selecting SIP [bookmark: marker-1533977]Preprocessor Options
 
     [bookmark: pgfId-1533985]License: Protection
 
     [bookmark: pgfId-1533986]The following list describes SIP preprocessor options you can modify.
 
     [bookmark: pgfId-1533987]For the Maximum Request URI Length, Maximum Call ID Length, Maximum Request Name Length, Maximum From Length, Maximum To Length, Maximum Via Length, Maximum Contact Length, and Maximum Content Length options, you can specify from 1 to 65535 bytes, or 0 to disable event generation for the option regardless of whether the associated rule is enabled.
 
     [bookmark: pgfId-1533988]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1533989]Ports
 
     [bookmark: pgfId-1533990]Specifies the ports to inspect for SIP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1533991]Methods to Check
 
     [bookmark: pgfId-1533992]Specifies SIP methods to detect. You can specify any of the following currently defined SIP methods:
 
      
      [bookmark: pgfId-1533993] ack, benotify, bye, cancel, do, info, invite, join, message, 
     
 
      
      [bookmark: pgfId-1533994] notify, options, prack, publish, quath, refer, register, 
     
 
      
      [bookmark: pgfId-1533995] service, sprack, subscribe, unsubscribe, update 
     
 
     [bookmark: pgfId-1533996]Methods are case-insensitive. The method name can include alphabetic characters, numbers, and the underscore character. No other special characters are permitted. Separate multiple methods with commas.
 
     [bookmark: pgfId-1533997]Because new SIP methods might be defined in the future, your configuration can include an alphabetic string that is not currently defined. The system supports up to 32 methods, including the 21 currently defined methods and an additional 11 methods. The system ignores any undefined methods that you might configure.
 
     [bookmark: pgfId-1533998]Note that, in addition to any methods you specify for this option, the 32 total methods includes methods specified using the sip_method keyword in intrusion rules. See sip_method for more information.
 
     [bookmark: pgfId-1534002]Maximum Dialogs within a Session
 
     [bookmark: pgfId-1534003]Specifies the maximum number of dialogs allowed within a stream session. If more dialogs than this number are created, the oldest dialogs are dropped until the number of dialogs does not exceed the maximum number specified; an event also triggers when rule 140:27 is enabled.
 
     [bookmark: pgfId-1534004]You can specify an integer from 1 to 4194303.
 
     [bookmark: pgfId-1534005]Maximum Request URI Length
 
     [bookmark: pgfId-1534006]Specifies the maximum number of bytes to allow in the Request-URI header field. A longer URI triggers an event when rule 140:3 is enabled. The request URI field indicates the destination path or page for the request.
 
     [bookmark: pgfId-1534007]Maximum Call ID Length
 
     [bookmark: pgfId-1534008]Specifies the maximum number of bytes to allow in the request or response Call-ID header field. A longer Call-ID triggers an event when rule 140:5 is enabled. The Call-ID field uniquely identifies the SIP session in requests and responses.
 
     [bookmark: pgfId-1534009]Maximum Request Name Length
 
     [bookmark: pgfId-1534010]Specifies the maximum number of bytes to allow in the request name, which is the name of the method specified in the CSeq transaction identifier. A longer request name triggers an event when rule 140:7 is enabled.
 
     [bookmark: pgfId-1534011]Maximum From Length
 
     [bookmark: pgfId-1534012]Specifies the maximum number of bytes to allow in the request or response From header field. A longer From triggers an event when rule 140:9 is enabled. The From field identifies the message initiator.
 
     [bookmark: pgfId-1534013]Maximum To Length
 
     [bookmark: pgfId-1534014]Specifies the maximum number of bytes to allow in the request or response To header field. A longer To triggers an event when rule 140:11 is enabled. The To field identifies the message recipient.
 
     [bookmark: pgfId-1534015]Maximum Via Length
 
     [bookmark: pgfId-1534016]Specifies the maximum number of bytes to allow in the request or response Via header field. A longer Via triggers an event when rule 140:13 is enabled. The Via field provides the path followed by the request and, in a response, receipt information.
 
     [bookmark: pgfId-1534017]Maximum Contact Length
 
     [bookmark: pgfId-1534018]Specifies the maximum number of bytes to allow in the request or response Contact header field. A longer Contact triggers an event when rule 140:15 is enabled. The Contact field provides a URI that specifies the location to contact with subsequent messages.
 
     [bookmark: pgfId-1534019]Maximum Content Length
 
     [bookmark: pgfId-1534020]Specifies the maximum number of bytes to allow in the content of the request or response message body. Longer content triggers an event when rule 140:16 is enabled.
 
     [bookmark: pgfId-1534021]Ignore Audio/Video Data Channel
 
     [bookmark: pgfId-1534022]Enables and disables inspection of data channel traffic. Note that the preprocessor continues inspection of other non-data-channel SIP traffic when you enable this option.
 
    
 
     
      [bookmark: pgfId-1534025][bookmark: 82687]Configuring the SIP Prep[bookmark: marker-1534024]rocessor
 
     [bookmark: pgfId-1534032]License: Protection
 
     [bookmark: pgfId-1534033]Use the following procedure to configure the SIP preprocessor.
 
     [bookmark: pgfId-1534034]To configure the SIP preprocessor:
 
     [bookmark: pgfId-1534038]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609097]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1572969]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1572974]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1572978]The Policy Information page appears.
 
     [bookmark: pgfId-1572979]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1572980]The Settings page appears.
 
     [bookmark: pgfId-1534053]Step 4 You have two choices, depending on whether SIP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1534054]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1534055]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1534056]The SIP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1534063]Step 5 You can modify any of the options described in Selecting SIP Preprocessor Options.
 
     [bookmark: pgfId-1534066]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1534070]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1534073][bookmark: 25926]Enabling Additional SIP [bookmark: marker-1534072]Preprocessor Rules
 
     [bookmark: pgfId-1534080]License: Protection
 
     [bookmark: pgfId-1534081]The SIP preprocessor rules in the following table are not associated with specific configuration options. As with other SIP preprocessor rules, you must enable these rules if you want them to generate events. See Setting Rule States for information on enabling rules.
 
     [bookmark: pgfId-1534170]
 
      
       
        
        [bookmark: pgfId-1534091]Table 27-10 [bookmark: 44208]Additional SIP Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534095]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1534097]Description 
          
  
        
 
         
         	[bookmark: pgfId-1534099]140:1
  
         	[bookmark: pgfId-1534101]Generates an event when the preprocessor is monitoring the maximum number of SIP sessions allowed by the system.
  
        
 
         
         	[bookmark: pgfId-1534103]140:2
  
         	[bookmark: pgfId-1534105]Generates an event when the required Request_URI field is empty in a SIP request.
  
        
 
         
         	[bookmark: pgfId-1534107]140:4
  
         	[bookmark: pgfId-1534109]Generates an event when the Call-ID header field is empty in a SIP request or response.
  
        
 
         
         	[bookmark: pgfId-1534111]140:6
  
         	[bookmark: pgfId-1534113]Generates an event when the value for the sequence number in the SIP request or response CSeq field is not a 32-bit unsigned integer less than 231.
  
        
 
         
         	[bookmark: pgfId-1534115]140:8
  
         	[bookmark: pgfId-1534117]Generates an event an event when the From header field is empty in a SIP request or response. 
  
        
 
         
         	[bookmark: pgfId-1534119]140:10
  
         	[bookmark: pgfId-1534121]Generates an event when the To header field is empty in a SIP request or response.
  
        
 
         
         	[bookmark: pgfId-1534123]140:12
  
         	[bookmark: pgfId-1534125]Generates an event when the Via header field is empty in a SIP request or response
  
        
 
         
         	[bookmark: pgfId-1534127]140:14
  
         	[bookmark: pgfId-1534129]Generates an event when the required Contact header field is empty in a SIP request or response.
  
        
 
         
         	[bookmark: pgfId-1534131]140:17
  
         	[bookmark: pgfId-1534133]Generates an event when a single SIP request or response packet in UDP traffic contains multiple messages. Note that older SIP versions supported multiple messages, but SIP 2.0 supports only one message per packet.
  
        
 
         
         	[bookmark: pgfId-1534135]140:18
  
         	[bookmark: pgfId-1534137]Generates an event when the actual length of the message body in a SIP request or response in UDP traffic does not match the value specified in the Content-Length header field in a SIP request or response.
  
        
 
         
         	[bookmark: pgfId-1534139]140:19
  
         	[bookmark: pgfId-1534141]Generates an event when the preprocessor does not recognize a method name in the CSeq field of a SIP response.
  
        
 
         
         	[bookmark: pgfId-1534143]140:20
  
         	[bookmark: pgfId-1534145]Generates an event when the SIP server does not challenge an authenticated invite message. Note that this occurs in the case of the InviteReplay billing attack.
  
        
 
         
         	[bookmark: pgfId-1534147]140:21
  
         	[bookmark: pgfId-1534149]Generates an event when session information changes before the call is set up. Note that this occurs in the case of the FakeBusy billing attack.
  
        
 
         
         	[bookmark: pgfId-1534151]140:22
  
         	[bookmark: pgfId-1534153]Generates an event when the response status code is not a three-digit number.
  
        
 
         
         	[bookmark: pgfId-1534155]140:23
  
         	[bookmark: pgfId-1534157]Generates an event when the Content-Type header field does not specify a content type and the message body contains data.
  
        
 
         
         	[bookmark: pgfId-1534159]140:24
  
         	[bookmark: pgfId-1534161]Generates an event when the SIP version is not 1, 1.1, or 2.0.
  
        
 
         
         	[bookmark: pgfId-1534163]140:25
  
         	[bookmark: pgfId-1534165]Generates an event when the method specified in the CSeq header and the method field do not match in a SIP request.
  
        
 
         
         	[bookmark: pgfId-1534167]140:26
  
         	[bookmark: pgfId-1534169]Generates an event when the preprocessor does not recognize the method named in the SIP request method field.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1534174][bookmark: 19270]Configuring the GTP Com[bookmark: marker-1534173]mand Channel
 
    [bookmark: pgfId-1534182]License: Protection
 
    [bookmark: pgfId-1534183]The General Service Packet Radio (GPRS) Tunneling Protocol (GTP) provides communication over a GTP core network. The GTP preprocessor detects anomalies in GTP traffic and forwards command channel signaling messages to the rules engine for inspection. You can use the gtp_version, gtp_type, and gtp_info rule keywords to inspect GTP command channel traffic for exploits.
 
    [bookmark: pgfId-1534184]A single configuration option allows you to modify the default setting for the ports that the preprocessor inspects for GTP command channel messages.
 
     
      
       
       [bookmark: pgfId-1534200]Table 27-11 GTP Preprocessor Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1534204]Preprocessor Rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1534206]Description 
         
  
       
 
        
        	[bookmark: pgfId-1534208]143:1
  
        	[bookmark: pgfId-1534210]Generates an event when the preprocessor detects an invalid message length.
  
       
 
        
        	[bookmark: pgfId-1534212]143:2
  
        	[bookmark: pgfId-1534214]Generates an event when the preprocessor detects an invalid information element length.
  
       
 
        
        	[bookmark: pgfId-1534216]143:3
  
        	[bookmark: pgfId-1534218]Generates an event when the preprocessor detects information elements that are out of order.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1534220]You can use the following procedure to modify the ports the GTP preprocessor monitors for GTP command messages.
 
    [bookmark: pgfId-1534221]To configure the GTP command channel:
 
    [bookmark: pgfId-1534225]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1609110]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1572998]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1573003]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1573007]The Policy Information page appears.
 
    [bookmark: pgfId-1573008]Step 3 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1573009]The Settings page appears.
 
    [bookmark: pgfId-1534239]Step 4 You have two choices, depending on whether GTP Command Channel Configuration under Application Layer Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1534240]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1534241]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1534242]The GTP Command Channel Configuration page appears.
 
    [bookmark: pgfId-1534243]Step 5 Optionally, modify the ports that the preprocessor inspects for GTP command messages. You can specify an integer from 0 to 65535. Use commas to separate multiple ports.
 
    [bookmark: pgfId-1534246]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1534250]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1534255][bookmark: 22886][bookmark: 61174]Decoding IM[bookmark: marker-1534254]AP Traffic
 
    [bookmark: pgfId-1534263]License: Protection
 
    [bookmark: pgfId-1534264]The Internet Message Application Protocol (IMAP) is used to retrieve email from a remote IMAP server. The IMAP preprocessor inspects server-to-client IMAP4 traffic and, when associated preprocessor rules are enabled, generates events on anomalous traffic. The preprocessor can also extract and decode email attachments in client-to-server IMAP4 traffic and send the attachment data to the rules engine. You can use the file_data keyword in an intrusion rule to point to the attachment data. See Pointing to a Specific Payload Type for more information.
 
    [bookmark: pgfId-1534268]Extraction and decoding include multiple attachments, when present, and large attachments that span multiple packets.
 
    [bookmark: pgfId-1534277]If you want IMAP preprocessor rules to generate events, you must enable the rules. IMAP preprocessor rules have a generator ID (GID) of 141.See Setting Rule States for more information.
 
    [bookmark: pgfId-1534281]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1534285]Selecting IMAP Preprocessor Options
 
     	 [bookmark: pgfId-1534289]Configuring the IMAP Preprocessor
 
     	 [bookmark: pgfId-1534293]Enabling Additional IMAP Preprocessor Rules
 
    
 
     
      [bookmark: pgfId-1534296][bookmark: 22577]Selecting IMAP [bookmark: marker-1534295]Preprocessor Options
 
     [bookmark: pgfId-1534303]License: Protection
 
     [bookmark: pgfId-1534304]The following list describes the IMAP preprocessor options you can modify.
 
     [bookmark: pgfId-1534305]Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.
 
     [bookmark: pgfId-1602669]Note also that the highest value is used when the values for the Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth options are different in:
 
      
      	 [bookmark: pgfId-1602672]the default network analysis policy
 
      	 [bookmark: pgfId-1602681]any other custom network analysis policy invoked by network analysis rules in the same access control policy
 
     
 
     [bookmark: pgfId-1640696]See Setting the Default Network Analysis Policy for Access Control and Specifying Traffic to Preprocess Using Network Analysis Rules for more information.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1640698] 
      Caution Changing the value for 
      Base64 Decoding Depth, 
      7-Bit/8-Bit/Binary Decoding Depth, 
      Quoted-Printable Decoding Depth, or 
      Unix-to-Unix Decoding Depth restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1534313]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1534314]Ports
 
     [bookmark: pgfId-1534315]Specifies the ports to inspect for IMAP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1534320]Base64 Decoding Depth
 
     [bookmark: pgfId-1534321]Specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data.
 
     [bookmark: pgfId-1534322]Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.
 
     [bookmark: pgfId-1534323]When Base64 decoding is enabled, you can enable rule 141:4 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.
 
     [bookmark: pgfId-1534324]7-Bit/8-Bit/Binary Decoding Depth
 
     [bookmark: pgfId-1534325]Specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as plain text, jpeg images, mp3 files, and so on. You can specify from 1 to 65535 bytes, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data.
 
     [bookmark: pgfId-1534326]Quoted-Printable Decoding Depth
 
     [bookmark: pgfId-1534327]Specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data.
 
     [bookmark: pgfId-1534328]When quoted-printable decoding is enabled, you can enable rule 141:6 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.
 
     [bookmark: pgfId-1534329]Unix-to-Unix Decoding Depth
 
     [bookmark: pgfId-1534330]Specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uuencoded) email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all uuencoded data in the packet. Specify -1 to ignore uuencoded data.
 
     [bookmark: pgfId-1534331]When Unix-to-Unix decoding is enabled, you can enable rule 141:7 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data.
 
    
 
     
      [bookmark: pgfId-1534334][bookmark: 98313]Configuring the [bookmark: IMAP preprocessor]IMAP Preprocessor
 
     [bookmark: pgfId-1534341]License: Protection
 
     [bookmark: pgfId-1534342]Use the following procedure to configure the IMAP preprocessor. For additional information on IMAP preprocessor configuration options, see Selecting IMAP Preprocessor Options. 
 
     [bookmark: pgfId-1534346]To configure the IMAP preprocessor:
 
     [bookmark: pgfId-1534350]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609123]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1573023]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573028]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573032]The Policy Information page appears.
 
     [bookmark: pgfId-1573033]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573034]The Settings page appears.
 
     [bookmark: pgfId-1534365]Step 4 You have two choices, depending on whether IMAP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1534366]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1534367]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1534368]The IMAP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1534372]Step 5 Specify the Ports where IMAP traffic should be decoded. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1534377]Step 6 Specify the maximum bytes of data to extract and decode from any combination of the following email attachment types:
 
      
       
       	 [bookmark: pgfId-1534378] Base64 Decoding Depth 
 
       	 [bookmark: pgfId-1534379] 7-Bit/8-Bit/Binary Decoding Depth (includes various multipart content types such as plain text, jpeg images, mp3 files, and so on)
 
       	 [bookmark: pgfId-1534380] Quoted-Printable Decoding Depth 
 
       	 [bookmark: pgfId-1534381] Unix-to-Unix Decoding Depth 
 
      
 
     
 
     [bookmark: pgfId-1534382]For each type, you can specify from 1 to 65535 bytes, or specify 0 to extract and, when necessary, decode all data in the packet. Specify -1 to ignore data for an attachment type.
 
     [bookmark: pgfId-1534383]You can use the file_data rule keyword in intrusion rules to inspect the attachment data. See Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1534389]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1534393]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1534396][bookmark: 62734]Enabling Additional IMAP [bookmark: IMAP preprocessor]Preprocessor Rules
 
     [bookmark: pgfId-1534403]License: Protection
 
     [bookmark: pgfId-1534404]The IMAP preprocessor rules in the following table are not associated with specific configuration options. As with other IMAP preprocessor rules, you must enable these rules if you want them to generate events. See Setting Rule States for information on enabling rules.
 
     [bookmark: pgfId-1534432]
 
      
       
        
        [bookmark: pgfId-1534413]Table 27-12 Additional IMAP Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534417]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1534419]Description 
          
  
        
 
         
         	[bookmark: pgfId-1534421]141:1
  
         	[bookmark: pgfId-1534423]Generates an event when the preprocessor detects a client command that is not defined in RFC 3501.
  
        
 
         
         	[bookmark: pgfId-1534425]141:2
  
         	[bookmark: pgfId-1534427]Generates an event when the preprocessor detects a server response that is not defined in RFC 3501.
  
        
 
         
         	[bookmark: pgfId-1534429]141:3
  
         	[bookmark: pgfId-1534431]Generates an event when the preprocessor is using the maximum amount of memory allowed by the system. At this point, the preprocessor stops decoding until memory becomes available.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1534436][bookmark: 20303]Decoding P[bookmark: marker-1534435]OP Traffic
 
    [bookmark: pgfId-1534444]License: Protection
 
    [bookmark: pgfId-1534445]The Post Office Protocol (POP) is used to retrieve email from a remote POP mail server. The POP preprocessor inspects server-to-client POP3 traffic and, when associated preprocessor rules are enabled, generates events on anomalous traffic. The preprocessor can also extract and decode email attachments in client-to-server POP3 traffic and send the attachment data to the rules engine. You can use the file_data keyword in an intrusion rule to point to attachment data. See Pointing to a Specific Payload Type for more information.
 
    [bookmark: pgfId-1534449]Extraction and decoding include multiple attachments, when present, and large attachments that span multiple packets.
 
    [bookmark: pgfId-1534458]If you want POP preprocessor rules to generate events, you must enable the rules. POP preprocessor rules have a generator ID (GID) of 142. See Setting Rule States for more information.
 
    [bookmark: pgfId-1534462]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1534466]Selecting POP Preprocessor Options
 
     	 [bookmark: pgfId-1534470]Configuring the POP Preprocessor
 
     	 [bookmark: pgfId-1534474]Enabling Additional POP Preprocessor Rules
 
    
 
     
      [bookmark: pgfId-1534477][bookmark: 39673]Selecting POP [bookmark: marker-1534476]Preprocessor Options
 
     [bookmark: pgfId-1534484]License: Protection
 
     [bookmark: pgfId-1534485]The following list describes the POP preprocessor options you can modify.
 
     [bookmark: pgfId-1534486]Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.
 
     [bookmark: pgfId-1534487]Note also that when the values for the Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth options are different in an intrusion policy associated with the default action of an access control policy and intrusion policies associated with access control rules, the highest value is used. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1640815] 
      Caution Changing the value for 
      Base64 Decoding Depth, 
      7-Bit/8-Bit/Binary Decoding Depth, 
      Quoted-Printable Decoding Depth, or 
      Unix-to-Unix Decoding Depth restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1534494]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1534495]Ports
 
     [bookmark: pgfId-1534496]Specifies the ports to inspect for POP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1534501]Base64 Decoding Depth
 
     [bookmark: pgfId-1534502]Specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data.
 
     [bookmark: pgfId-1534503]Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.
 
     [bookmark: pgfId-1534504]When Base64 decoding is enabled, you can enable rule 142:4 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534508]7-Bit/8-Bit/Binary Decoding Depth
 
     [bookmark: pgfId-1534509]Specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as plain text, jpeg images, mp3 files, and so on. You can specify from 1 to 65535 bytes, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data.
 
     [bookmark: pgfId-1534510]Quoted-Printable Decoding Depth
 
     [bookmark: pgfId-1534511]Specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data.
 
     [bookmark: pgfId-1534512]When quoted-printable decoding is enabled, you can enable rule 142:6 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534516]Unix-to-Unix Decoding Depth
 
     [bookmark: pgfId-1534517]Specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uuencoded) email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all uuencoded data in the packet. Specify -1 to ignore uuencoded data.
 
     [bookmark: pgfId-1534518]When Unix-to-Unix decoding is enabled, you can enable rule 142:7 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1534524][bookmark: 43732]Configuring the [bookmark: POP preprocessor]POP Preprocessor
 
     [bookmark: pgfId-1534531]License: Protection
 
     [bookmark: pgfId-1534532]Use the following procedure to configure the POP preprocessor. For additional information on POP preprocessor configuration options, see Selecting POP Preprocessor Options.
 
     [bookmark: pgfId-1534536]To configure the POP preprocessor:
 
     [bookmark: pgfId-1534540]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609169]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1573052]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573057]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573061]The Policy Information page appears.
 
     [bookmark: pgfId-1573062]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573063]The Settings page appears.
 
     [bookmark: pgfId-1534555]Step 4 You have two choices, depending on whether POP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1534556]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1534557]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1534558]The POP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1534562]Step 5 Specify the Ports where IMAP traffic should be decoded. Separate multiple port numbers with commas. 
 
     [bookmark: pgfId-1534567]Step 6 Specify the maximum bytes of data to extract and decode from any combination of the following email attachment types:
 
      
       
       	 [bookmark: pgfId-1534568] Base64 Decoding Depth 
 
       	 [bookmark: pgfId-1534569] 7-Bit/8-Bit/Binary Decoding Depth (includes various multipart content types such as plain text, jpeg images, mp3 files, and so on)
 
       	 [bookmark: pgfId-1534570] Quoted-Printable Decoding Depth 
 
       	 [bookmark: pgfId-1534571] Unix-to-Unix Decoding Depth 
 
      
 
     
 
     [bookmark: pgfId-1534572]For each type, you can specify from 1 to 65535 bytes, or specify 0 to extract and, when necessary, decode all data in the packet. Specify -1 to ignore data for an attachment type.
 
     [bookmark: pgfId-1534573]You can use the file_data rule keyword in intrusion rules to inspect the attachment data. See Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1534579]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1534583]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1534586][bookmark: 51320]Enabling Additional POP [bookmark: POP preprocessor]Preprocessor Rules
 
     [bookmark: pgfId-1534593]License: Protection
 
     [bookmark: pgfId-1534594]The POP preprocessor rules in the following table are not associated with specific configuration options. As with other POP preprocessor rules, you must enable these rules if you want them to generate events. See Setting Rule States for information on enabling rules.
 
     [bookmark: pgfId-1534622]
 
      
       
        
        [bookmark: pgfId-1534603]Table 27-13 Additional POP Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534607]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1534609]Description 
          
  
        
 
         
         	[bookmark: pgfId-1534611]142:1
  
         	[bookmark: pgfId-1534613]Generates an event when the preprocessor detects a client command that is not defined in RFC 1939.
  
        
 
         
         	[bookmark: pgfId-1534615]142:2
  
         	[bookmark: pgfId-1534617]Generates an event when the preprocessor detects a server response that is not defined in RFC 1939.
  
        
 
         
         	[bookmark: pgfId-1534619]142:3
  
         	[bookmark: pgfId-1534621]Generates an event when the preprocessor is using the maximum amount of memory allowed by the system. At this point, the preprocessor stops decoding until memory becomes available.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1534626][bookmark: 85623]Decod[bookmark: marker-1534624]ing S[bookmark: SMTP]MTP Traffic
 
    [bookmark: pgfId-1534633]License: Protection
 
    [bookmark: pgfId-1534634]The SMTP preprocessor instructs the rules engine to normalize SMTP commands. The preprocessor can also extract and decode email attachments in client-to-server traffic and, depending on the software version, extract email file names, addresses, and header data to provide context when displaying intrusion events triggered by SMTP traffic.
 
    [bookmark: pgfId-1534635]Note the following when using the SMTP preprocessor:
 
     
     	 [bookmark: pgfId-1587488]You must enable SMTP preprocessor rules, which have a generator ID (GID) of 124, if you want these rules to generate events. See Setting Rule States for more information.
 
    
 
    [bookmark: pgfId-1587492]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1534651]Understanding SMTP Decoding
 
     	 [bookmark: pgfId-1534655]Configuring SMTP Decoding
 
     	 [bookmark: pgfId-1534659]Enabling SMTP Maximum Decoding Memory Alerting
 
    
 
     
      [bookmark: pgfId-1534662][bookmark: 95434]Understanding SMTP [bookmark: marker-1534661]Decoding
 
     [bookmark: pgfId-1534669]License: Protection
 
     [bookmark: pgfId-1534670]You can enable or disable normalization, and you can configure options to control the types of anomalous traffic the SMTP decoder detects.
 
     [bookmark: pgfId-1534671]Note that decoding, or extraction when the MIME email attachment does not require decoding, includes multiple attachments when present, and large attachments that span multiple packets.
 
     [bookmark: pgfId-1646370]Note also that when the values for the Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, or Unix-to-Unix Decoding Depth options are different in an intrusion policy associated with the default action of an access control policy and intrusion policies associated with access control rules, the highest value is used. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1646372] 
      Caution Changing the value for 
      Base64 Decoding Depth, 
      7-Bit/8-Bit/Binary Decoding Depth, 
      Quoted-Printable Decoding Depth, or 
      Unix-to-Unix Decoding Depth restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1646376]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1534680]Ports
 
     [bookmark: pgfId-1534681]Specifies the ports whose SMTP traffic you want to normalize. You can specify an integer from 0 to 65535. Separate multiple ports with commas.
 
     [bookmark: pgfId-1534686]Stateful Inspection
 
     [bookmark: pgfId-1534687]When selected, causes SMTP decoder to save state and provide session context for individual packets and only inspects reassembled sessions. When cleared, analyzes each individual packet without session context.
 
     [bookmark: pgfId-1534688]Normalize
 
     [bookmark: pgfId-1534689]When set to All, normalizes all commands. Checks for more than one space character after a command.
 
     [bookmark: pgfId-1534690]When set to None, normalizes no commands.
 
     [bookmark: pgfId-1534691]When set to Cmds, normalizes the commands listed in Custom Commands.
 
     [bookmark: pgfId-1534692]Custom Commands
 
     [bookmark: pgfId-1534693]When Normalize is set to Cmds, normalizes the listed commands. 
 
     [bookmark: pgfId-1534694]Specify commands which should be normalized in the text box. Checks for more than one space character after a command. 
 
     [bookmark: pgfId-1534695]The space (ASCII 0x20) and tab (ASCII 0x09) characters count as space characters for normalization purposes. 
 
     [bookmark: pgfId-1534696]Ignore Data 
 
     [bookmark: pgfId-1534697]Does not process mail data; processes only MIME mail header data.
 
     [bookmark: pgfId-1534698]Ignore TLS Data
 
     [bookmark: pgfId-1534699]Does not process data encrypted under the Transport Layer Security protocol.
 
     [bookmark: pgfId-1534700]No Alerts 
 
     [bookmark: pgfId-1534701]Disables intrusion events when accompanying preprocessor rules are enabled.
 
     [bookmark: pgfId-1534702]Detect Unknown Commands
 
     [bookmark: pgfId-1534703]Detects unknown commands in SMTP traffic.
 
     [bookmark: pgfId-1534706]You can enable rules 124:5 and 124:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534708]Max Command Line Len
 
     [bookmark: pgfId-1534709]Detects when an SMTP command line is longer than this value. Specify 0 to never detect command line length.
 
     [bookmark: pgfId-1534710]RFC 2821, the Network Working Group specification on the Simple Mail Transfer Protocol, recommends 512 as a maximum command line length.
 
     [bookmark: pgfId-1534714]You can enable rule 124:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534715]Max Header Line Len 
 
     [bookmark: pgfId-1534716]Detects when an SMTP data header line is longer than this value. Specify 0 to never detect data header line length. 
 
     [bookmark: pgfId-1534719]You can enable rules 124:2 and 124:7 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534721]Max Response Line Len
 
     [bookmark: pgfId-1534722]Detects when an SMTP response line is longer than this value. Specify 0 to never detect response line length.
 
     [bookmark: pgfId-1534723]RFC 2821 recommends 512 as a maximum response line length.
 
     [bookmark: pgfId-1534727]You can enable rule 124:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534728]Alt Max Command Line Len
 
     [bookmark: pgfId-1534729]Detects when the SMTP command line for any of the specified commands is longer than this value. Specify 0 to never detect command line length for the specified commands. Different default line lengths are set for numerous commands. 
 
     [bookmark: pgfId-1534730]This setting overrides the Max Command Line Len setting for the specified commands.
 
     [bookmark: pgfId-1534734]You can enable rule 124:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534735]Invalid Commands
 
     [bookmark: pgfId-1534736]Detects if these commands are sent from the client side.
 
     [bookmark: pgfId-1534739]You can enable rule 124:5 and 124:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534741]Valid Commands
 
     [bookmark: pgfId-1534742]Permits commands in this list. 
 
     [bookmark: pgfId-1534743]Even if this list is empty, the preprocessor permits the following valid commands: ATRN AUTH BDAT DATA DEBUG EHLO EMAL ESAM ESND ESOM ETRN EVFY EXPN HELO HELP IDENT MAIL NOOP ONEX QUEU QUIT RCPT RSET SAML SEND SIZE SOML STARTTLS TICK TIME TURN TURNME VERB VRFY XADR XAUTH XCIR XEXCH50 X-EXPS XGEN XLICENSE X-LINK2STATE XQUE XSTA XTRN XUSR 
 
      
       
     
 
     
 
     [bookmark: pgfId-1534744]Note RCPT TO and MAIL FROM are SMTP commands. The preprocessor configuration uses command names of RCPT and MAIL, respectively. Within the code, the preprocessor maps RCPT and MAIL to the correct command name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534748]You can enable rule 124:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534749]Data Commands
 
     [bookmark: pgfId-1534750]Lists commands that initiate sending data in the same way the SMTP DATA command sends data per RFC 5321. Separate multiple commands with spaces.
 
     [bookmark: pgfId-1534751]Binary Data Commands
 
     [bookmark: pgfId-1534752]Lists commands that initiate sending data in a way that is similar to how the BDAT command sends data per RFC 3030. Separate multiple commands with spaces.
 
     [bookmark: pgfId-1534753]Authentication Commands
 
     [bookmark: pgfId-1534754]Lists commands that initiate an authentication exchange between client and server. Separate multiple commands with spaces.
 
     [bookmark: pgfId-1534755]Detect xlink2state
 
     [bookmark: pgfId-1534756]Detects packets that are part of X-Link2State Microsoft Exchange buffer data overflow attacks. In inline deployments, the system can also drop those packets. 
 
     [bookmark: pgfId-1534760]You can enable rule 124:8 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534761]Base64 Decoding Depth
 
     [bookmark: pgfId-1534762]When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each Base64 encoded MIME email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all the Base64 data. Specify -1 to ignore Base64 data. The preprocessor will not decode data when Ignore Data is selected.
 
     [bookmark: pgfId-1534763]Note that positive values not divisible by 4 are rounded up to the next multiple of 4 except for the values 65533, 65534, and 65535, which are rounded down to 65532.
 
     [bookmark: pgfId-1534764]When Base64 decoding is enabled, you can enable rule 124:10 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534768]Note that this option replaces the deprecated options Enable MIME Decoding and Maximum MIME Decoding Depth, which are still supported in existing intrusion policies for backward compatibility.
 
     [bookmark: pgfId-1534769]7-Bit/8-Bit/Binary Decoding Depth
 
     [bookmark: pgfId-1534770]When Ignore Data is disabled, specifies the maximum bytes of data to extract from each MIME email attachment that does not require decoding. These attachment types include 7-bit, 8-bit, binary, and various multipart content types such as plain text, jpeg images, mp3 files, and so on. You can specify from 1 to 65535 bytes, or specify 0 to extract all data in the packet. Specify -1 to ignore non-decoded data. The preprocessor will not extract data when Ignore Data is selected.
 
     [bookmark: pgfId-1534771]Quoted-Printable Decoding Depth
 
     [bookmark: pgfId-1534772]When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each quoted-printable (QP) encoded MIME email attachment. 
 
     [bookmark: pgfId-1534773]You can specify from 1 to 65535 bytes, or specify 0 to decode all QP encoded data in the packet. Specify -1 to ignore QP encoded data. The preprocessor will not decode data when Ignore Data is selected.
 
     [bookmark: pgfId-1534774]When quoted-printable decoding is enabled, you can enable rule 124:11 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534778]Unix-to-Unix Decoding Depth
 
     [bookmark: pgfId-1534779]When Ignore Data is disabled, specifies the maximum number of bytes to extract and decode from each Unix-to-Unix encoded (uuencoded) email attachment. You can specify from 1 to 65535 bytes, or specify 0 to decode all uuencoded data in the packet. Specify -1 to ignore uuencoded data. The preprocessor will not decode data when Ignore Data is selected.
 
     [bookmark: pgfId-1534780]When Unix-to-Unix decoding is enabled, you can enable rule 124:13 to generate an event when decoding fails; decoding could fail, for example, because of incorrect encoding or corrupted data. See Setting Rule States for more information.
 
     [bookmark: pgfId-1534784]Log MIME Attachment Names
 
     [bookmark: pgfId-1534785]Enables extraction of MIME attachment file names from the MIME Content-Disposition header and associates the file names with all intrusion events generated for the session. Multiple file names are supported.
 
     [bookmark: pgfId-1534786]When this option is enabled, you can view file names associated with events in the Email Attachment column of the intrusion events table view. See Understanding Intrusion Events for more information.
 
     [bookmark: pgfId-1534790]Log To Addresses
 
     [bookmark: pgfId-1534791]Enables extraction of recipient email addresses from the SMTP RCPT TO command and associates the recipient addresses with all intrusion events generated for the session. Multiple recipients are supported. 
 
     [bookmark: pgfId-1534792]When this option is enabled, you can view recipients associated with events in the Email Recipient column of the intrusion events table view. See Understanding Intrusion Events for more information.
 
     [bookmark: pgfId-1534796]Log From Addresses
 
     [bookmark: pgfId-1534797]Enables extraction of sender email addresses from the SMTP MAIL FROM command and associates the sender addresses with all intrusion events generated for the session. Multiple sender addresses are supported. 
 
     [bookmark: pgfId-1534798]When this option is enabled, you can view senders associated with events in the Email Sender column of the intrusion events table view. See Understanding Intrusion Events for more information.
 
     [bookmark: pgfId-1534802]Log Headers
 
     [bookmark: pgfId-1534803]Enables extraction of email headers. The number of bytes to extract is determined by the value specified for Header Log Depth.
 
     [bookmark: pgfId-1534804]You can use the content or protected_content keyword to write intrusion rules that use email header data as a pattern. You can also view the extracted email header in the intrusion event packet view. See Constraining Content Matches and Using the Packet View for more information. 
 
     [bookmark: pgfId-1534811]Header Log Depth
 
     [bookmark: pgfId-1534812]Specifies the number of bytes of the email header to extract when Log Headers is enabled. You can specify 0 to 20480 bytes. A value of 0 disables Log Headers.
 
    
 
     
      [bookmark: pgfId-1534816][bookmark: 91533]Configuring SMTP [bookmark: marker-1534815]Decoding
 
     [bookmark: pgfId-1534823]License: Protection
 
     [bookmark: pgfId-1534825]You can use the SMTP Configuration page of an intrusion policy to configure SMTP normalization. For more information on SMTP preprocessor configuration options, see Understanding SMTP Decoding.
 
     [bookmark: pgfId-1534829]To configure SMTP decoding options:
 
     [bookmark: pgfId-1534833]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609182]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1573085]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573090]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573094]The Policy Information page appears.
 
     [bookmark: pgfId-1573095]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573096]The Settings page appears.
 
     [bookmark: pgfId-1534848]Step 4 You have two choices, depending on whether SMTP Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1534849]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1534850]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1534854]The SMTP Configuration page appears. The following graphic shows the Defense Center packet view. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1534858]Step 5 Specify the Ports where SMTP traffic should be decoded, separated by commas. 
 
     [bookmark: pgfId-1534859]Step 6 Select Stateful Inspection to examine reassembled TCP streams containing SMTP packets. Clear Stateful Inspection to inspect only unreassembled SMTP packets.
 
     [bookmark: pgfId-1534860]Step 7 Configure the normalization options:
 
      
       
       	 [bookmark: pgfId-1534861]To normalize all commands, select  All .
 
       	 [bookmark: pgfId-1534862]To normalize only commands specified by  Custom Commands , select  Cmds and specify the commands to normalize. Separate commands with spaces.
 
       	 [bookmark: pgfId-1534863]To normalize no commands, select  None .
 
       	 [bookmark: pgfId-1534864]To ignore mail data except for MIME mail header data, check  Ignore Data .
 
       	 [bookmark: pgfId-1534865]To ignore data encrypted under the Transport Security Layer protocol, check  Ignore TLS Data .
 
       	 [bookmark: pgfId-1534866]To disable generating events when accompanying preprocessor rules are enabled, check  No Alerts .
 
       	 [bookmark: pgfId-1534867]To detect unknown commands in SMTP data, select  Detect Unknown Commands .
 
      
 
     
 
     [bookmark: pgfId-1534868]Step 8 Specify a maximum command line length in the Max Command Line Len field. 
 
     [bookmark: pgfId-1534869]Step 9 Specify a maximum data header line length in the Max Header Line Len field. 
 
     [bookmark: pgfId-1534870]Step 10 Specify a maximum response line length in the Max Response Line Len field. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1534871]Note RCPT TO and MAIL FROM are SMTP commands. The preprocessor configuration uses command names of RCPT and MAIL, respectively. Within the code, the preprocessor maps RCPT and MAIL to the correct command name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534872]Step 11 If needed, click Add next to Alt Max Command Line Len to add commands where you want to specify an alternate maximum command line length, then specify the line length and the command or commands, separated by spaces, where you want that length to be enforced. 
 
     [bookmark: pgfId-1534873]Step 12 Specify any commands that you want to treat as invalid and detect in the Invalid Commands field. Separate commands with spaces.
 
     [bookmark: pgfId-1534874]Step 13 Specify any commands that you want to treat as valid in the Valid Commands field. Separate commands with spaces.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534875]Note Even if the Valid Commands list is empty, the preprocessor treats the following commands as valid: ATRN, AUTH, BDAT, DATA, DEBUG, EHLO, EMAL, ESAM, ESND, ESOM, ETRN, EVFY, EXPN, HELO, HELP, IDENT, MAIL, NOOP, QUIT, RCPT, RSET, SAML, SOML, SEND, ONEX, QUEU, STARTTLS, TICK, TIME, TURN, TURNME, VERB, VRFY, X-EXPS, X-LINK2STATE, XADR, XAUTH, XCIR, XEXCH50, XGEN, XLICENSE, XQUE, XSTA, XTRN, or XUSR. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534876]Step 14 Specify any commands that you want to initiate sending data in the same way the SMTP DATA command sends data per RFC 5321 in the Data Commands field. Separate commands with spaces.
 
     [bookmark: pgfId-1534877]Step 15 Specify any commands that initiate sending data in a way that is similar to how the BDAT command sends data per RFC 3030 in the Binary Data Commands field. Separate commands with spaces.
 
     [bookmark: pgfId-1534878]Step 16 Specify any commands that initiate an authentication exchange between client and server in the Authentication Commands field. Separate commands with spaces.
 
     [bookmark: pgfId-1534879]Step 17 To detect packets that are part of X-Link2State Microsoft Exchange buffer data overflow attacks, select Detect xlink2state.
 
     [bookmark: pgfId-1534880]Step 18 To specify the maximum bytes of data to extract and decode for different types of email attachment, specify a value for any of the following attachment types:
 
      
       
       	 [bookmark: pgfId-1534881] Base64 Decoding Depth 
 
       	 [bookmark: pgfId-1534882] 7-Bit/8-Bit/Binary Decoding Depth (includes various multipart content types such as plain text, jpeg images, mp3 files, and so on)
 
       	 [bookmark: pgfId-1534883] Quoted-Printable Decoding Depth 
 
       	 [bookmark: pgfId-1534884] Unix-to-Unix Decoding Depth 
 
      
 
     
 
     [bookmark: pgfId-1534885]You can specify from 1 to 65535 bytes, or specify 0 to extract and, when necessary, decode all data in the packet for that type. Specify -1 to ignore data for an attachment type.
 
     [bookmark: pgfId-1534888]You can use the file_data rule keyword in intrusion rules to inspect extracted data. See Pointing to a Specific Payload Type for more information.
 
     [bookmark: pgfId-1534890]You must also select the SMTP Stateful Inspection option to extract and decode cross-packet data or data crossing multiple TCP segments.
 
     [bookmark: pgfId-1534891]Step 19 Configure options for associating contextual information with intrusion events triggered by SMTP traffic:
 
      
       
       	 [bookmark: pgfId-1534892]To enable extraction of MIME attachment file names to associate with intrusion events, select  Log MIME Attachment Names .
 
       	 [bookmark: pgfId-1534893]To enable extraction of recipient email addresses, select  Log To Addresses .
 
       	 [bookmark: pgfId-1534894]To enable extraction of sender email addresses to associate with intrusion events, select  Log From Addresses .
 
       	 [bookmark: pgfId-1534895]To enable extraction of email headers to associate with intrusion events and for writing rules that inspect email headers, select  Log Headers .
 
      
 
     
 
     [bookmark: pgfId-1534896]Note that header information is displayed in the intrusion event packet view. Note also that you can also write intrusion rules that use the content or protected_content keyword with email header data as a pattern. See Viewing Event Information and Searching for Content Matches for more information.
 
     [bookmark: pgfId-1534903]Optionally, you can specify a Header Log Depth of 0 to 20480 bytes of the email header to extract. A value of 0 disables Log Headers.
 
     [bookmark: pgfId-1534906]Step 20 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1534910]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1534913][bookmark: 51982]Enabling SMTP [bookmark: marker-1534912]Maximum Decoding Memory Alerting
 
     [bookmark: pgfId-1534920]License: Protection
 
     [bookmark: pgfId-1534921]You can enable SMTP preprocessor rule 124:9 to generate an event when the enabled preprocessor is using the maximum amount of memory allowed by the system for decoding the following types of encoded data:
 
      
      	 [bookmark: pgfId-1534922]Base64
 
      	 [bookmark: pgfId-1534923]7-bit/8-bit/binary
 
      	 [bookmark: pgfId-1534924]Quoted-printable
 
      	 [bookmark: pgfId-1534925]Unix-to-Unix
 
     
 
     [bookmark: pgfId-1534926]When the maximum decoding memory is exceeded, the preprocessor stops decoding these types of encoded data until memory becomes available. This preprocessor rule is not associated with a single, specific configuration option. See Setting Rule States for information on enabling rules.
 
    
 
   
 
    
     [bookmark: pgfId-1534932][bookmark: 65555]Detecting Exploits Using the S[bookmark: marker-1534931]SH Preprocessor
 
    [bookmark: pgfId-1534939]License: Protection
 
    [bookmark: pgfId-1534940]The SSH preprocessor detects the Challenge-Response Buffer Overflow exploit, the CRC-32 exploit, the SecureCRT SSH Client Buffer Overflow exploit, protocol mismatches, and incorrect SSH message direction. The preprocessor also detects any version string other than version 1 or 2.
 
    [bookmark: pgfId-1534941]Challenge-Response Buffer Overflow and CRC-32 attacks occur after the key exchange and are, therefore, encrypted. Both attacks send an uncharacteristically large payload of more than 20 KBytes to the server immediately after the authentication challenge. CRC-32 attacks apply only to SSH Version 1; Challenge-Response Buffer Overflow exploits apply only to SSH Version 2. The version string is read at the beginning of the session. Except for the difference in the version string, both attacks are handled in the same way.
 
    [bookmark: pgfId-1534942]The SecureCRT SSH exploit and protocol mismatch attacks occur when attempting to secure a connection, before the key exchange. The SecureCRT exploit sends an overly long protocol identifier string to the client that causes a buffer overflow. A protocol mismatch occurs when either a non-SSH client application attempts to connect to a secure SSH server or the server and client version numbers do not match.
 
    [bookmark: pgfId-1534943]You can configure the preprocessor to inspect traffic on a specified port or list of ports, or to automatically detect SSH traffic. It will continue to inspect SSH traffic until either a specified number of encrypted packets has passed within a specified number of bytes, or until a specified maximum number of bytes is exceeded within the specified number of packets. If the maximum number of bytes is exceeded, it is assumed that a CRC-32 (SSH Version 1) or a Challenge-Response Buffer Overflow (SSH Version 2) attack has occurred. Additionally, you can detect the SecureCRT exploit, protocol mismatches, and bad message direction. Note that the preprocessor detects without configuration any version string value other than version 1 or 2.
 
    [bookmark: pgfId-1534944]Note the following when using the SSH preprocessor:
 
     
     	 [bookmark: pgfId-1534945]You must enable SSH preprocessor rules, which have a generator ID (GID) of 128, if you want these rules to generate events. See Setting Rule States for more information.
 
     	 [bookmark: pgfId-1534956]The SSH preprocessor does not handle brute force attacks. For information on brute force attempts, see Adding Dynamic Rule States. 
 
    
 
    [bookmark: pgfId-1534960]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1534964]Selecting SSH Preprocessor Options
 
     	 [bookmark: pgfId-1534968]Configuring the SSH Preprocessor
 
    
 
     
      [bookmark: pgfId-1534971][bookmark: 40989]Selecting SSH Prepr[bookmark: marker-1534970]ocessor Options
 
     [bookmark: pgfId-1534978]License: Protection
 
     [bookmark: pgfId-1534979]This section describes the options you can use to configure the SSH preprocessor.
 
     [bookmark: pgfId-1534980]The preprocessor stops inspecting traffic for a session when either of the following occurs: 
 
      
      	 [bookmark: pgfId-1534981]a valid exchange between the server and the client has occurred for this number of encrypted packets; the connection continues.
 
      	 [bookmark: pgfId-1534982]the  Number of Bytes Sent Without Server Response  is reached before the number of encrypted packets to inspect is reached; the assumption is made that there is an attack.
 
     
 
     [bookmark: pgfId-1534983]Each valid server response during Number of Encrypted Packets to Inspect resets the Number of Bytes Sent Without Server Response and the packet count continues.
 
     [bookmark: pgfId-1534984]Consider the following example SSH preprocessor configuration:
 
      
      	 [bookmark: pgfId-1534985] Server Ports : 22
 
      	 [bookmark: pgfId-1534986] Autodetect Ports : off
 
      	 [bookmark: pgfId-1534987] Maximum Length of Protocol Version String : 80
 
      	 [bookmark: pgfId-1534988] Number of Encrypted Packets to Inspect : 25
 
      	 [bookmark: pgfId-1534989] Number of Bytes Sent Without Server Response : 19,600
 
      	 [bookmark: pgfId-1534990]All detect options are enabled.
 
     
 
     [bookmark: pgfId-1534991]In the example, the preprocessor inspects traffic only on port 22. That is, auto-detection is disabled, so it inspects only on the specified port.
 
     [bookmark: pgfId-1534992]Additionally, the preprocessor in the example stops inspecting traffic when either of the following occurs:
 
      
      	 [bookmark: pgfId-1534993]The client sends 25 encrypted packets which contain no more than 19,600 bytes, cumulative. The assumption is there is no attack.
 
      	 [bookmark: pgfId-1534994]The client sends more than 19,600 bytes within 25 encrypted packets. In this case, the preprocessor considers the attack to be the Challenge-Response Buffer Overflow exploit because the session in the example is an SSH Version 2 session.
 
     
 
     [bookmark: pgfId-1534995]The preprocessor in the example will also detect any of the following that occur while it is processing traffic:
 
      
      	 [bookmark: pgfId-1534996]a server overflow, triggered by a version string greater than 80 bytes and indicating a SecureCRT exploit
 
      	 [bookmark: pgfId-1534997]a protocol mismatch
 
      	 [bookmark: pgfId-1534998]a packet flowing in the wrong direction
 
     
 
     [bookmark: pgfId-1534999]Finally, the preprocessor will automatically detect any version string other than version 1 or version 2.
 
     [bookmark: pgfId-1535000]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1535001]Server Ports
 
     [bookmark: pgfId-1535002]Specifies on which ports the SSH preprocessor should inspect traffic.
 
     [bookmark: pgfId-1535003]You can configure a single port or a comma-separated list of ports.
 
     [bookmark: pgfId-1535004]Autodetect Ports
 
     [bookmark: pgfId-1535005]Sets the preprocessor to automatically detect SSH traffic. 
 
     [bookmark: pgfId-1535006]When this option is selected, the preprocessor inspects all traffic for an SSH version number. It stops processing when neither the client nor the server packet contains a version number. When disabled, the preprocessor inspects only the traffic identified by the Server Ports option.
 
     [bookmark: pgfId-1535007]Number of Encrypted Packets to Inspect
 
     [bookmark: pgfId-1535008]Specifies the number of encrypted packets to examine per session. 
 
     [bookmark: pgfId-1535009]Setting this option to zero will allow all traffic to pass. 
 
     [bookmark: pgfId-1535010]Reducing the number of encrypted packets to inspect may result in some attacks escaping detection. Raising the number of encrypted packets to inspect may negatively affect performance.
 
     [bookmark: pgfId-1535011]Number of Bytes Sent Without Server Response
 
     [bookmark: pgfId-1535012]Specifies the maximum number of bytes an SSH client may send to a server without getting a response before assuming there is a Challenge-Response Buffer Overflow or CRC-32 attack.
 
     [bookmark: pgfId-1535013]Increase the value for this option if the preprocessor generates false positives on the Challenge-Response Buffer Overflow or CRC-32 exploit.
 
     [bookmark: pgfId-1535014]Maximum Length of Protocol Version String
 
     [bookmark: pgfId-1535015]Specifies the maximum number of bytes allowed in the server’s version string before considering it to be a SecureCRT exploit. 
 
     [bookmark: pgfId-1535016]Detect Challenge-Response Buffer Overflow Attack
 
     [bookmark: pgfId-1535017]Enables or disables detecting the Challenge-Response Buffer Overflow exploit.
 
     [bookmark: pgfId-1535021]You can enable rule 128:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535022]Detect SSH1 CRC-32 Attack
 
     [bookmark: pgfId-1535023]Enables or disables detecting the CRC-32 exploit.
 
     [bookmark: pgfId-1535027]You can enable rule 128:2 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535028]Detect Server Overflow
 
     [bookmark: pgfId-1535029]Enables or disables detecting the SecureCRT SSH Client Buffer Overflow exploit.
 
     [bookmark: pgfId-1535033]You can enable rule 128:3 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535034]Detect Protocol Mismatch
 
     [bookmark: pgfId-1535035]Enables or disables detecting protocol mismatches.
 
     [bookmark: pgfId-1535039]You can enable rule 128:4 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535040]Detect Bad Message Direction
 
     [bookmark: pgfId-1535041]Enables or disables detecting when traffic flows in the wrong direction (that is, if the presumed server generates client traffic, or if a client generates server traffic).
 
     [bookmark: pgfId-1535045]You can enable rule 128:5 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535046]Detect Payload Size Incorrect for the Given Payload
 
     [bookmark: pgfId-1535047]Enables or disables detecting packets with an incorrect payload size such as when the length specified in the SSH packet is not consistent with the total length specified in the IP header or the message is truncated, that is, there is not enough data for a full SSH header.
 
     [bookmark: pgfId-1535051]You can enable rule 128:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535052]Detect Bad Version String
 
     [bookmark: pgfId-1535053]Note that, when enabled, the preprocessor detects without configuration any version string other than version 1 or 2.
 
     [bookmark: pgfId-1535057]You can enable rule 128:7 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1535061][bookmark: 48844]Configu[bookmark: marker-1535059]ring the SSH Preprocessor
 
     [bookmark: pgfId-1535069]License: Protection
 
     [bookmark: pgfId-1535070]This section explains how to configure the SSH preprocessor.
 
     [bookmark: pgfId-1535071]To configure the SSH preprocessor:
 
     [bookmark: pgfId-1535075]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609195]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1573118]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573123]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573127]The Policy Information page appears.
 
     [bookmark: pgfId-1573128]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573129]The Settings page appears.
 
     [bookmark: pgfId-1535090]Step 4 You have two choices, depending on whether SSH Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1535091]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1535092]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1535093]The SSH Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1535099]Step 5 You can modify any of the options on the SSH Configuration preprocessor page. See Selecting SSH Preprocessor Options for more information.
 
     [bookmark: pgfId-1535103]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1535107]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1535112][bookmark: 50778]Usi[bookmark: marker-1535109]ng the S[bookmark: SSL]SL Preprocessor
 
    [bookmark: pgfId-1535120]License: feature-dependent
 
    [bookmark: pgfId-1627005]The SSL preprocessor allows you to configure SSL inspection, which can block encrypted traffic, decrypt it, or inspect the traffic with access control. Whether you configure SSL inspection, the SSL preprocessor also analyzes SSL handshake messages when detected in traffic and determines when a session becomes encrypted. Identifying encrypted traffic allows the system to stop intrusion and file inspection of encrypted payloads, which helps reduce false positives and improve performance. See Understanding Traffic Decryption and Creating and Editing Access Control Rules for more information.
 
    [bookmark: pgfId-1626892]The SSL preprocessor can also examine encrypted traffic to detect attempts to exploit the Heartbleed bug, and generate events when it detects such exploits.
 
    [bookmark: pgfId-1630234]Using the SSL preprocessor to decrypt encrypted traffic does not require a license. All other SSL preprocessor functionality, including halting inspection of encrypted payloads for malware and intrusions, and detecting Heartbleed bug exploits, requires a Protection license. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1627092]Note The system-provided network analysis policies enable the SSL preprocessor by default. Cisco recommends you do not disable the SSL preprocessor in custom deployments if you expect encrypted traffic to cross your network.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1535134]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1535138]Understanding SSL Preprocessing
 
     	 [bookmark: pgfId-1535142]Enabling SSL Preprocessor Rules
 
     	 [bookmark: pgfId-1553333]Configuring the SSL Preprocessor
 
    
 
     
      [bookmark: pgfId-1553336][bookmark: 25159]Understanding SSL Preproc[bookmark: marker-1553335]essing
 
     [bookmark: pgfId-1553343]License: Protection
 
     [bookmark: pgfId-1535157]The SSL preprocessor stops intrusion and file inspection of encrypted data, and inspects encrypted traffic with an SSL policy if you configure SSL inspection. This can help to eliminate false positives. The SSL preprocessor maintains state information as it inspects the SSL handshake, tracking both the state and SSL version for that session. When the preprocessor detects that a session state is encrypted, the system marks the traffic in that session as encrypted. You can configure the system to stop processing on all packets in an encrypted session when encryption is established, as well as generate an event when it detects an attempt to exploit the Heartbleed bug.
 
     [bookmark: pgfId-1535166]For each packet, the SSL preprocessor verifies that the traffic contains an IP header, a TCP header, and a TCP payload, and that it occurs on the ports specified for SSL preprocessing. For qualifying traffic, the following scenarios determine whether the traffic is encrypted:
 
      
      	 [bookmark: pgfId-1535167]the system observes all packets in a session,  Server side data is trusted is not enabled, and the session includes a Finished message from both the server and the client and at least one packet from each side with an Application record and without an Alert record
 
      	 [bookmark: pgfId-1535168]the system misses some of the traffic,  Server side data is trusted is not enabled, and the session includes at least one packet from each side with an Application record that is not answered with an Alert record
 
      	 [bookmark: pgfId-1535169]the system observes all packets in a session,  Server side data is trusted is enabled, and the session includes a Finished message from the client and at least one packet from the client with an Application record and without an Alert record
 
      	 [bookmark: pgfId-1535170]the system misses some of the traffic,  Server side data is trusted is enabled, and the session includes at least one packet from the client with an Application record that is not answered with an Alert record
 
     
 
     [bookmark: pgfId-1535171]If you choose to stop processing on encrypted traffic, the system ignores future packets in a session after it marks the session as encrypted.
 
     [bookmark: pgfId-1615733]In addition, during the SSL handshake, the preprocessor monitors heartbeat requests and responses. The preprocessor generates an event if it detects:
 
      
      	 [bookmark: pgfId-1615734]a heartbeat request containing a payload length value greater than the payload itself
 
      	 [bookmark: pgfId-1615735]a heartbeat response that is larger than the value stored in the Max Heartbeat Length field
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1535172]Note You can add the ssl_state and ssl_version keywords to a rule to use SSL state or version information within the rule. For more information, see Extracting SSL Information from a Session. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1535178][bookmark: 25289]Enabling SSL [bookmark: marker-1535177]Preprocessor Rules
 
     [bookmark: pgfId-1535185]License: Protection
 
     [bookmark: pgfId-1535186]When enabled, the SSL preprocessor inspects the contents of the handshake and key exchange messages exchanged at the beginning of an SSL session. You can suspend inspecting traffic for intrusions and malware once the session is encrypted. If you configure SSL inspection, the SSL preprocessor also identifies encrypted traffic you can block, decrypt, or inspect with access control. 
 
     [bookmark: pgfId-1535187]Note that you must enable SSL preprocessor rules, which have a generator ID (GID) of 137, if you want these rules to generate events. See Setting Rule States for more information.
 
     [bookmark: pgfId-1535191]The following table describes the SSL preprocessor rules you can enable.
 
     [bookmark: pgfId-1535216]
 
      
       
        
        [bookmark: pgfId-1535198]Table 27-14 [bookmark: 71127]SSL Preprocessor Rules 
 
        
        
         
         	 
           
           [bookmark: pgfId-1535202]Preprocessor Rule GID:SID 
          
  
         	 
           
           [bookmark: pgfId-1535204]Description 
          
  
        
 
         
         	[bookmark: pgfId-1535206]137:1
  
         	[bookmark: pgfId-1535208]Detects a client hello after a server hello, which is invalid and considered to be anomalous behavior.
  
        
 
         
         	[bookmark: pgfId-1535210]137:2
  
         	[bookmark: pgfId-1535212]Detects a server hello without a client hello when Server side data is trusted is disabled, which is invalid and considered to be anomalous behavior. See Configuring the SSL Preprocessor for more information.
  
        
 
         
         	[bookmark: pgfId-1611150]137:3
  
         	[bookmark: pgfId-1611152]Detects a heartbeat request with a payload length greater than the payload itself when Max Heartbeat Length contains a non-zero value, which indicates an attempt to exploit the Heartbleed bug.
  
        
 
         
         	[bookmark: pgfId-1611146]137:4
  
         	[bookmark: pgfId-1611148]Detects a heartbeat response larger than a non-zero value specified in Max Heartbeat Length, which indicates an attempt to exploit the Heartbleed bug.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1535219][bookmark: 73665]Configuring the SSL Preproc[bookmark: marker-1535218]essor
 
     [bookmark: pgfId-1535226]License: Protection
 
     [bookmark: pgfId-1535227]Without SSL inspection configured, the system attempts to inspect encrypted traffic for malware and intrusions without decrypting it. When you enable the SSL preprocessor, it detects when a session becomes encrypted. After the SSL preprocessor is enabled, the rules engine can invoke the preprocessor to obtain SSL state and version information. If you enable rules using the ssl_state and ssl_version keywords in an intrusion policy, you should also enable the SSL preprocessor in that policy.
 
     [bookmark: pgfId-1535228]In addition, you can enable the Stop inspecting encrypted traffic option to disable inspection and reassembly for encrypted sessions. The SSL preprocessor maintains state for the session so it can disable inspection of all traffic in the session. The system only stops inspecting traffic in encrypted sessions if SSL preprocessing is enabled and the Stop inspecting encrypted traffic option is selected. Note that if you clear the Stop inspecting encrypted traffic option, you cannot modify the Server side data is trusted option.
 
     [bookmark: pgfId-1579079]To base identification of encrypted traffic only on server traffic, you can enable the Server side data is trusted option; that is, server side data is trusted to indicate that the traffic is encrypted. The SSL preprocessor typically checks both client traffic and the server responses to that traffic to determine if a session is encrypted. However, because the system may not mark a transaction as encrypted if it cannot detect both sides of a session, you can rely on the SSL server to indicate a session is encrypted. Note that when you enable the Server side data is trusted option you must also enable the Stop inspecting encrypted traffic option so the system does not continue inspecting traffic in the encrypted session.
 
     [bookmark: pgfId-1615740]You can configure the preprocessor Max Heartbeat Length option to detect attempts to exploit the Heartbleed bug by examining heartbeat requests and responses within the SSL handshake. If the preprocessor detects a heartbeat request whose payload length is greater than the actual payload length, or a heartbeat response greater in size than the Max Heartbeat Length value, the preprocessor generates an event. 
 
     [bookmark: pgfId-1579080]You can specify the ports where the preprocessor monitors traffic for encrypted sessions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1579081]Note If the SSL preprocessor detects non-SSL traffic over the ports specified for SSL monitoring, it tries to decode the traffic as SSL traffic, and then flags it as corrupt.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1535232]To configure the SSL preprocessor:
 
     [bookmark: pgfId-1535236]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1609208]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1573147]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1573152]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1573156]The Policy Information page appears.
 
     [bookmark: pgfId-1573157]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1573158]The Settings page appears.
 
     [bookmark: pgfId-1535251]Step 4 You have two choices, depending on whether SSL Configuration under Application Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1535252]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1535253]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1535254]The SSL Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1535258]Step 5 Type the ports, separated by commas, where the SSL preprocessor should monitor traffic for encrypted sessions. Only ports included in the Ports field will be checked for encrypted traffic.
 
     [bookmark: pgfId-1535259]Step 6 Click the Stop inspecting encrypted traffic check box to enable or disable inspection of traffic in a session after the session is marked as encrypted. 
 
     [bookmark: pgfId-1535260]Step 7 Click the Server side data is trusted check box to enable or disable identification of encrypted traffic based only on the client-side traffic.
 
     [bookmark: pgfId-1615745]Step 8 Enter a number of bytes in the Max Heartbeat Length field to enable inspection of heartbeat requests and responses within the SSL handshake for Heartbleed bug exploit attempts. You can specify an integer from 1 to 65535, or 0 to disable the option.
 
     [bookmark: pgfId-1612666]Step 9 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1627637]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1531574][bookmark: 75511]Configuring SCADA Preprocessing 
      
      
 
     
 
 
    [bookmark: pgfId-1533796]You configure Supervisory Control and Data Acquisition (SCADA) preprocessors in a network analysis policy, which prepares traffic for inspection using the rules enabled in an intrusion policy. See Understanding Network Analysis and Intrusion Policies for more information.
 
    [bookmark: pgfId-1534426]SCADA protocols monitor, control, and acquire data from industrial, infrastructure, and facility processes such as manufacturing, production, water treatment, electric power distribution, airport and shipping systems, and so on. The FireSIGHT System provides preprocessors for the Modbus and DNP3 SCADA protocols that you can configure as part of your network analysis policy.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1535890] 
     Caution Some users with custom user roles cannot access the network analysis policy via the standard menu path ( 
     Policies > Access Control > Network Analysis Policy). These users can access the network analysis policy through the intrusion policy: 
     Policies > Intrusion > Intrusion Policy > Network Analysis Policy. For more information on custom user roles, see 
     Managing Custom User Roles. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1534683]If you enable a rule containing Modbus or DNP3 keywords in the corresponding intrusion policy, the system automatically uses the Modbus or DNP3 processor, respectively, with its current settings, although the preprocessor remains disabled in the network analysis policy web interface. For more information, see Modbus Keywords and DNP3 Keywords.
 
    [bookmark: pgfId-1534434]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1534438]Configuring the Modbus Preprocessor
 
     	 [bookmark: pgfId-1532206]Configuring the DNP3 Preprocessor
 
     	 [bookmark: pgfId-1552837]Configuring the CIP Preprocessor
 
    
 
   
 
    
     [bookmark: pgfId-1532210][bookmark: 24867]Configuring the Mod[bookmark: marker-1532209]bus Preprocessor
 
    [bookmark: pgfId-1532218]License: Protection
 
    [bookmark: pgfId-1532219]The Modbus protocol, which was first published in 1979 by Modicon, is a widely used SCADA protocol. The Modbus preprocessor detects anomalies in Modbus traffic and decodes the Modbus protocol for processing by the rules engine, which uses Modbus keywords to access certain protocol fields. See Modbus Keywords for more information.
 
    [bookmark: pgfId-1532223]A single configuration option allows you to modify the default setting for the port that the preprocessor inspects for Modbus traffic.
 
    [bookmark: pgfId-1532224]You must enable the Modbus preprocessor rules in the following table if you want these rules to generate events. See Setting Rule States for information on enabling rules.
 
    [bookmark: pgfId-1532253]
 
     
      
       
       [bookmark: pgfId-1532233]Table 28-1 Modbus Preprocessor Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1532237]Preprocessor Rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1532239]Description 
         
  
       
 
        
        	[bookmark: pgfId-1532241]144:1
  
        	[bookmark: pgfId-1532243]Generates an event when the length in the Modbus header does not match the length required by the Modbus function code.
 [bookmark: pgfId-1532244]Each Modbus function has an expected format for requests and responses. If the length of the message does not match the expected format, this event is generated.
  
       
 
        
        	[bookmark: pgfId-1532246]144:2
  
        	[bookmark: pgfId-1532248]Generates an event when the Modbus protocol ID is non-zero. The protocol ID field is used for multiplexing other protocols with Modbus. Because the preprocessor does not process these other protocols, this event is generated instead.
  
       
 
        
        	[bookmark: pgfId-1532250]144:3
  
        	[bookmark: pgfId-1532252]Generates an event when the preprocessor detects a reserved Modbus function code.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1532254]Note regarding the use of the Modbus preprocessor that if your network does not contain any Modbus-enabled devices, you should not enable this preprocessor in a network analysis policy that you apply to traffic.
 
    [bookmark: pgfId-1532268]You can use the following procedure to modify the ports the Modbus preprocessor monitors.
 
    [bookmark: pgfId-1532269]To configure the Modbus preprocessor:
 
    [bookmark: pgfId-1532273]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1532274]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1532275]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1532280]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1532284]The Policy Information page appears.
 
    [bookmark: pgfId-1532285]Step 3 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1532286]The Settings page appears.
 
    [bookmark: pgfId-1532287]Step 4 You have two choices, depending on whether Modbus Configuration under SCADA Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1532288]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1532289]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1532290]The Modbus Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1532291]Step 5 Optionally, modify the Ports that the preprocessor inspects for Modbus traffic. You can specify an integer from 0 to 65535. Use commas to separate multiple ports.
 
    [bookmark: pgfId-1532294]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1532298]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1532302][bookmark: 51145]Configuring the DNP3 P[bookmark: marker-1532301]reprocessor
 
    [bookmark: pgfId-1532310]License: Protection
 
    [bookmark: pgfId-1532311]The Distributed Network Protocol (DNP3) is a SCADA protocol that was originally developed to provide consistent communication between electrical stations. DNP3 has also become widely used in the water, waste, transportation, and many other industries. 
 
    [bookmark: pgfId-1532312]The DNP3 preprocessor detects anomalies in DNP3 traffic and decodes the DNP3 protocol for processing by the rules engine, which uses DNP3 keywords to access certain protocol fields. See DNP3 Keywords for more information.
 
    [bookmark: pgfId-1532316]You must enable the DNP3 preprocessor rules in the following table if you want these rules to generate events. See Setting Rule States for information on enabling rules.
 
    [bookmark: pgfId-1532356]
 
     
      
       
       [bookmark: pgfId-1532325]Table 28-2 DNP3 Preprocessor Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1532329]Preprocessor Rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1532331]Description 
         
  
       
 
        
        	[bookmark: pgfId-1532333]145:1
  
        	[bookmark: pgfId-1532335]When Log bad CRC is enabled, generates an event when the preprocessor detects a link layer frame with an invalid checksum.
  
       
 
        
        	[bookmark: pgfId-1532337]145:2
  
        	[bookmark: pgfId-1532339]Generates an event and blocks the packet when the preprocessor detects a DNP3 link layer frame with an invalid length.
  
       
 
        
        	[bookmark: pgfId-1532341]145:3
  
        	[bookmark: pgfId-1532343]Generates an event and blocks the packet during reassembly when the preprocessor detects a transport layer segment with an invalid sequence number.
  
       
 
        
        	[bookmark: pgfId-1532345]145:4
  
        	[bookmark: pgfId-1532347]Generates an event when the DNP3 reassembly buffer is cleared before a complete fragment can be reassembled. This happens when a segment carrying the FIR flag appears after other segments have been queued.
  
       
 
        
        	[bookmark: pgfId-1532349]145:5
  
        	[bookmark: pgfId-1532351]Generates an event when the preprocessor detects a DNP3 link layer frame that uses a reserved address.
  
       
 
        
        	[bookmark: pgfId-1532353]145:6
  
        	[bookmark: pgfId-1532355]Generates an event when the preprocessor detects a DNP3 request or response that uses a reserved function code.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1532357]Note regarding the use of the DNP3 preprocessor that, if your network does not contain any DNP3-enabled devices, you should not enable this preprocessor in a network analysis policy that you apply to traffic. See Configuring TCP Stream Preprocessing for more information.
 
    [bookmark: pgfId-1532371]The following list describes the DNP3 preprocessor options you can configure.
 
    [bookmark: pgfId-1532372]Ports
 
    [bookmark: pgfId-1532373]Enables inspection of DNP3 traffic on each specified port. You can specify a single port or a comma-separated list of ports. You can specify a value from 0 to 65535 for each port.
 
    [bookmark: pgfId-1532374]Log bad CRCs
 
    [bookmark: pgfId-1532375]When enabled, validates the checksums contained in DNP3 link layer frames. Frames with invalid checksums are ignored.
 
    [bookmark: pgfId-1532376]You can enable rule 145:1 to generate events when invalid checksums are detected.
 
    [bookmark: pgfId-1532377]To configure the DNP3 preprocessor:
 
    [bookmark: pgfId-1532381]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1532382]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1532383]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1532388]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1532392]The Policy Information page appears.
 
    [bookmark: pgfId-1532393]Step 3 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1532394]The Settings page appears.
 
    [bookmark: pgfId-1532395]Step 4 You have two choices, depending on whether DNP3 Configuration under SCADA Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1532396]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1532397]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1532398]The DNP3 Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1532399]Step 5 Optionally, modify the Ports that the preprocessor inspects for DNP3 traffic. You can specify an integer from 0 to 65535. Use commas to separate multiple ports.
 
    [bookmark: pgfId-1532400]Step 6 Optionally, select or clear the Log bad CRCs check box to specify whether to validate the checksums contained in DNP3 link layer frames and ignore frames with invalid checksums.
 
    [bookmark: pgfId-1532403]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See the Network Analysis Policy Editing Actions table for more information.
 
    [bookmark: pgfId-1545743]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1552845][bookmark: 87080]Configuring the CI[bookmark: marker-1552844]P Preprocessor
 
    [bookmark: pgfId-1552853]License: Protection
 
    [bookmark: pgfId-1552854]The Common Industrial Protocol (CIP) is a widely used application protocol that supports industrial automation applications. EtherNet/IP is an implementation of CIP that is used on Ethernet-based networks.
 
    [bookmark: pgfId-1552855]The CIP preprocessor detects CIP and ENIP traffic running on TCP or UDP and sends it to the intrusion rules engine. You can use CIP and ENIP keywords in custom intrusion rules to detect attacks in CIP and ENIP traffic. See CIP and ENIP Keywords. Additionally, you can control traffic by specifying CIP and ENIP application conditions in access control rules. See Controlling Application Traffic.
 
    [bookmark: pgfId-1552862]Note the following:
 
     
     	 [bookmark: pgfId-1552863]To detect CIP and ENIP applications and use them in access control rules, intrusion rules and so on, you must manually enable the CIP preprocessor in the corresponding network analysis policy. See Setting the Default Network Analysis Policy for Access Control and Specifying Traffic to Preprocess Using Network Analysis Rules.
 
     	 [bookmark: pgfId-1552870]To drop traffic that triggers CIP preprocessor rules and CIP intrusion rules, ensure that the corresponding intrusion policy  Drop when Inline option is enabled. See Setting Drop Behavior in an Inline Deployment.
 
     	 [bookmark: pgfId-1552874]To block CIP or ENIP application traffic using access control rules, ensure that the inline normalization preprocessor and its  Inline Mode option are enabled in the corresponding network analysis policy. See Normalizing Inline Traffic and Allowing Preprocessors to Affect Traffic in Inline Deployments.
 
     	 [bookmark: pgfId-1552881]Add the default CIP detection port 44818 and any other ports you list to the TCP stream  Perform Stream Reassembly on Both Ports list. See Selecting Stream Reassembly Options.
 
     	 [bookmark: pgfId-1552888]Event viewers give special handling to CIP applications. See Understanding CIP Events.
 
    
 
     
      
       
       [bookmark: pgfId-1552898]Table 28-3 CIP Preprocessor Rules 
 
       
       
        
        	 
          
          [bookmark: pgfId-1552902]Preprocessor Rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1552904]Rule Message 
         
  
       
 
        
        	[bookmark: pgfId-1552906]148:1
  
        	[bookmark: pgfId-1552908]CIP_MALFORMED
  
       
 
        
        	[bookmark: pgfId-1552910]148:2
  
        	[bookmark: pgfId-1552912]CIP_NON_CONFORMING
  
       
 
        
        	[bookmark: pgfId-1552914]148:3
  
        	[bookmark: pgfId-1552916]CIP_CONNECTION_LIMIT
  
       
 
        
        	[bookmark: pgfId-1552918]148:4
  
        	[bookmark: pgfId-1552920]CIP_REQUEST_LIMIT
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1552922]The following list describes CIP preprocessor options you can modify.
 
    [bookmark: pgfId-1552923]Ports
 
    [bookmark: pgfId-1552924]Specifies the ports to inspect for CIP and ENIP traffic. You can specify an integer from 0 to 65535. Separate multiple port numbers with commas.
 
     
      
    
 
    
 
    [bookmark: pgfId-1552925]Note You must add the default CIP detection port 44818 and any other ports you list to the TCP stream Perform Stream Reassembly on Both Ports list. See Selecting Stream Reassembly Options.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1552929]Default Unconnected Timeout (seconds)
 
    [bookmark: pgfId-1552930]When a CIP request message does not contain a protocol-specific timeout value and Maximum number of concurrent unconnected requests per TCP connection is reached, the system times the message for the number of seconds specified by this option. When the timer expires, the message is removed to make room for future requests. You can specify an integer from 0 to 360. When you specify 0, all traffic that does not have a protocol-specific timeout times out first.
 
    [bookmark: pgfId-1552931]Maximum number of concurrent unconnected requests per TCP connection
 
    [bookmark: pgfId-1552932]The number of concurrent requests that can go unanswered before the system closes the connection. You can specify an integer from 1 to 10000.
 
    [bookmark: pgfId-1552933]Maximum number of CIP connections per TCP connection
 
    [bookmark: pgfId-1552934]The maximum number of simultaneous CIP connections allowed by the system per TCP connection. You can specify an integer from 1 to 10000.
 
    [bookmark: pgfId-1552935]To configure the CIP preprocessor:
 
    [bookmark: pgfId-1552939]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1552940]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1552941]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1552946]If you have unsaved changes in another policy, click OK to discard those changes and continue.See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1552950]The Policy Information page appears.
 
    [bookmark: pgfId-1552951]Step 3 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1552952]The Settings page appears.
 
    [bookmark: pgfId-1552953]Step 4 You have two choices, depending on whether CIP Configuration under SCADA Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1552954]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1552955]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1552956]The CIP Configuration page appears. A message at the bottom of the page identifies the network analysis policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1552960]Step 5 You can modify any of the options described in this section.
 
    [bookmark: pgfId-1552961]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1552965]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1552967][bookmark: 53725]Understanding CIP Events
 
     [bookmark: pgfId-1552968]By design, application detectors detect and event viewers display the same application one time per session. A CIP session can include multiple applications in different packets, and a single CIP packet can contain multiple applications. The CIP preprocessor handles all CIP and ENIP traffic according to the corresponding rule and controls the display of CIP events as follows:
 
      
      	 [bookmark: pgfId-1552969]Application Protocol:  CIP or  ENIP 
 
      	 [bookmark: pgfId-1552970]Client:  CIP Client or  ENIP Client 
 
      	 [bookmark: pgfId-1552971]Web Application: the specific application detected, which is:
 
     
 
     [bookmark: pgfId-1552972] – For rules that allow or monitor traffic: the last application protocol detected in the session.
 
     [bookmark: pgfId-1552973]Note that access control rules that you configure to log connections might not generate events for specified CIP applications, and access control rules that you do not configure to log connections might generate events for CIP applications.
 
     [bookmark: pgfId-1552974] – For rules that block traffic: the application protocol that triggered the block.
 
     [bookmark: pgfId-1552975]When an access control rule blocks a list of CIP applications, event viewers display the first application that is detected.
 
     [bookmark: pgfId-1552976]Note the following:
 
      
      	 [bookmark: pgfId-1552977]Cisco recommends that you use an access control policy default action of  Intrusion Prevention .
 
      	 [bookmark: pgfId-1552978]The CIP preprocessor does not support an access control policy default action of  Access Control: Trust All Traffic which may produce undesirable behavior, including not dropping traffic triggered by CIP applications specified in intrusion rules and access control rules.
 
      	 [bookmark: pgfId-1552979]The CIP preprocessor does not support an access control policy default action of  Access Control: Block All Traffic which may produce undesirable behavior, including blocking CIP applications that you do not expect to be blocked. 
 
      	 [bookmark: pgfId-1552980]The CIP preprocessor does not support application visibility for CIP applications, including network discovery.
 
     
 
     [bookmark: pgfId-1552984]See Understanding Connection and Security Intelligence Data Fields for more information.
 
      
       [bookmark: pgfId-1164863]
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1583886][bookmark: 56912]Configuring Transport & Network Layer Preprocessing 
      
      
 
     
 
 
    [bookmark: pgfId-1583930]You configure most transport at network layer preprocessors in a network analysis policy, which prepares traffic for inspection using the rules enabled in an intrusion policy. See Understanding Network Analysis and Intrusion Policies for more information.
 
    [bookmark: pgfId-1590024]Transport and network layer preprocessors detect attacks that exploit IP fragmentation, checksum validation, and TCP and UDP session preprocessing. Before packets are sent to preprocessors, the packet decoder converts packet headers and payloads into a format that can be easily used by the preprocessors and the intrusion rules engine and detects various anomalous behaviors in packet headers. After packet decoding and before sending packets to other preprocessors, the inline normalization preprocessor normalizes traffic for inline deployments.
 
    [bookmark: pgfId-1590239]When an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s web interface. For more information, see Limitations of Custom Policies.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1590862] 
     Caution Some users with custom user roles cannot access the network analysis policy via the standard menu path ( 
     Policies > Access Control > Network Analysis Policy). These users can access the network analysis policy through the intrusion policy: 
     Policies > Intrusion > Intrusion Policy > Network Analysis Policy. For more information on custom user roles, see 
     Managing Custom User Roles. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1590026]You can tailor transport and network layer preprocessor settings that you configure in network analysis policies by VLAN, zone, or network. Some transport and network layer settings apply globally to all traffic, and you configure these in an access control policy.
 
     
     	 [bookmark: pgfId-1583995]Configuring Advanced Transport/Network Settings
 
     	 [bookmark: pgfId-1530807]Verifying Checksums
 
     	 [bookmark: pgfId-1530815]Normalizing Inline Traffic
 
     	 [bookmark: pgfId-1530819]Defragmenting IP Packets
 
     	 [bookmark: pgfId-1530823]Understanding Packet Decoding
 
     	 [bookmark: pgfId-1534383]Using TCP Stream Preprocessing
 
     	 [bookmark: pgfId-1551166]Using UDP Stream Preprocessing
 
    
 
   
 
    
     [bookmark: pgfId-1551168][bookmark: 18072]Configuring Advanced Transport/Network Settings
 
    [bookmark: pgfId-1557608]License: Protection
 
    [bookmark: pgfId-1580794]Advanced transport and network preprocessor settings apply globally to all networks, zones, and VLANs where you apply your access control policy. You configure these advanced settings in an access control policy rather than in a network analysis policy. 
 
    [bookmark: pgfId-1551481]The following sections describe these settings:
 
     
     	 [bookmark: pgfId-1551534]Ignoring VLAN Headers
 
     	 [bookmark: pgfId-1551539]Initiating Active Responses with Intrusion Drop Rules
 
     	 [bookmark: pgfId-1551541]Troubleshooting: Logging Session Termination Messages
 
    
 
     
      [bookmark: pgfId-1535601][bookmark: 69752]Ign[bookmark: marker-1535598]oring V[bookmark: marker-1535599]LAN Headers
 
     [bookmark: pgfId-1557590]License: Protection
 
     [bookmark: pgfId-1570917]Supported Devices: Any except ASA FirePOWER
 
     [bookmark: pgfId-1535608]Different VLAN tags in traffic traveling in different directions for the same connection can affect traffic reassembly and rule processing. For example, in the following graphic traffic for the same connection could be transmitted over VLAN A and received over VLAN B.
 
     [bookmark: pgfId-1598494]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1535617]When you enable Ignore the VLAN header when tracking connections, the system ignores the VLAN header so packets can be correctly processed for your deployment.
 
     [bookmark: pgfId-1535618]To ignore VLAN headers:
 
     [bookmark: pgfId-1535619]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1535620]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1535621]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1535626]The access control policy editor appears.
 
     [bookmark: pgfId-1535631]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1535632]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1536318]The Transport/Network Layer Preprocessor Settings pop-up window appears.
 
     [bookmark: pgfId-1535640]Step 5 You have the following choices:
 
      
       
       	 [bookmark: pgfId-1535641]For deployed devices that might detect different VLAN tags for the same connection in traffic traveling in different directions, select the  Ignore the VLAN header when tracking connections check box to ignore VLAN headers when identifying traffic.
 
       	 [bookmark: pgfId-1576730]For deployed devices that will not detect different VLAN tags for the same connection traffic traveling in different directions, clear the  Ignore the VLAN header when tracking connections check box to include VLAN headers when identifying traffic.
 
      
 
     
 
     [bookmark: pgfId-1576731]Step 6 Click OK. 
 
     [bookmark: pgfId-1576734]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    
 
     
      [bookmark: pgfId-1576738][bookmark: 63055]Initiating Active Respon[bookmark: marker-1576737]ses with Intrusion Drop Rules
 
     [bookmark: pgfId-1570980]License: Protection
 
     [bookmark: pgfId-1570981]A drop rule is an intrusion rule or preprocessor rule whose rule state is set to Drop and Generate Events. In an inline deployment, the system responds to TCP or UDP drop rules by dropping the triggering packet and blocking the session where the packet originated. In a passive deployment, the system cannot drop the packet and does not block the session except with the use of active responses.
 
      
       
     
 
     
 
     [bookmark: pgfId-1546716]Tip Because UDP data streams are not typically thought of in terms of sessions, see Using UDP Stream Preprocessing for further explanation of how the stream preprocessor uses the source and destination IP address fields in the encapsulating IP datagram header and the port fields in the UDP header to determine the direction of flow and identify a UDP session.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1546720]You can configure the Maximum Active Responses option to initiate one or more active responses to more precisely and specifically close a TCP connection or UDP session when an offending packet triggers a TCP or UDP drop rule.
 
     [bookmark: pgfId-1546721]When active responses are enabled in an inline deployment, the system responds to TCP drop rules by dropping the triggering packet and inserting a TCP Reset (RST) packet in both the client and server traffic. The system cannot drop the packet in a passive deployment; when active responses are enabled in a passive deployment, the system responds to TCP drop rules by sending a TCP reset to both the client and server ends of a TCP connection. When active responses are enabled in inline or passive deployments, the system closes a UDP session by sending an ICMP unreachable packet to each end of the session. Active responses are most effective in inline deployments because resets are more likely to arrive in time to affect the connection or session.
 
     [bookmark: pgfId-1546722]Depending on how you configure the Maximum Active Responses option, the system can also initiate additional active responses if it sees additional traffic from either end of the connection or session. The system initiates each additional active response, up to a specified maximum, after a specified number of seconds have elapsed since the previous response.
 
     [bookmark: pgfId-1546729]See Selecting The TCP Global Option for information on setting the maximum number of active responses.
 
     [bookmark: pgfId-1546730]Note that a triggered resp or react rule also initiates an active response regardless of the configuration of Maximum Active Responses; however, Maximum Active Responses control whether the system initiates additional active responses for resp and react rules in the same way it controls the maximum number of active responses for drop rules. See Initiating Active Responses with Rule Keywords for more information.
 
     [bookmark: pgfId-1546734]You can also use the config response command to configure the active response interface to use and the number of TCP resets to attempt in a passive deployment. See Setting the Active Response Reset Attempts and Interface for more information.
 
     [bookmark: pgfId-1546746]No preprocessor rules are associated with the following options.
 
     [bookmark: pgfId-1546751][bookmark: marker-1546750]Maximum Active Responses
 
     [bookmark: pgfId-1546752]Specifies a maximum of 1 to 25 active responses per TCP connection. When additional traffic occurs on a connection where an active response has been initiated, and the traffic occurs more than Minimum Response Seconds after a previous active response, the system sends another active response unless the specified maximum has been reached. A setting of 0 disables active responses triggered by drop rules and disables additional active responses triggered by resp or react rules. For more information, see Initiating Active Responses with Intrusion Drop Rules and Initiating Active Responses with Rule Keywords.
 
     [bookmark: pgfId-1546867]Min[bookmark: marker-1546866]imum Response Seconds
 
     [bookmark: pgfId-1546868]Until Maximum Active Responses occur, specifies waiting 1 to 300 seconds before any additional traffic on a connection where the system has initiated an active response results in a subsequent active response.
 
     [bookmark: pgfId-1546937]To initiate active responses with drop rules:
 
     [bookmark: pgfId-1577726]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1546939]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1546940]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1546945]The access control policy editor appears.
 
     [bookmark: pgfId-1546946]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1546947]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1546952]The Transport/Network Layer Preprocessor Settings pop-up window appears.
 
     [bookmark: pgfId-1546953]Step 5 You have the following options:
 
      
       
       	 [bookmark: pgfId-1547569]Specify a value 1 to 25 of  Maximum Active Responses per TCP connection. A setting of 0 disables active responses triggered by drop rules and disables additional active responses triggered by  resp or  react rules.
 
       	 [bookmark: pgfId-1547647]Specify a value 1 to 300 of  Minimum Response Seconds to wait until either  Maximum Active Responses occur or any additional traffic on a connection where the system has initiated an active response results in a subsequent active response.
 
      
 
     
 
     [bookmark: pgfId-1574221]Step 6 Click OK. 
 
     [bookmark: pgfId-1585644]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    
 
     
      [bookmark: pgfId-1585647][bookmark: 72453]Troubleshooting: Logging Session Termination Messages
 
     [bookmark: pgfId-1585651]License: Protection
 
     [bookmark: pgfId-1577626]Support might ask you during a troubleshooting call to configure your system to log a message when an individual connection exceeds the specified threshold. Changing the setting for this option will affect performance and should be done only with Support guidance.
 
     [bookmark: pgfId-1548100]To log session termination messages:
 
     [bookmark: pgfId-1577745]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1548102]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1548103]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
     
 
     [bookmark: pgfId-1548108]The access control policy editor appears.
 
     [bookmark: pgfId-1548109]Step 3 Select the Advanced tab.
 
     [bookmark: pgfId-1548110]The access control policy advanced settings page appears.
 . 
     
 
     [bookmark: pgfId-1548115]The Transport/Network Layer Preprocessor Settings pop-up window appears.
 
     [bookmark: pgfId-1548116]Step 5 Expand Troubleshooting Options.
 
     [bookmark: pgfId-1581093]Step 6 Specify for Session Termination Logging Threshold the number of bytes that result in a logged message when the session terminates and the specified number was exceeded. 
 
     [bookmark: pgfId-1581102]The upper limit of 1GB is also restricted by the amount of memory on the managed device allocated for stream processing. 
 
     [bookmark: pgfId-1574245]Step 7 Click OK. 
 
     [bookmark: pgfId-1574248]You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    
 
   
 
    
     [bookmark: pgfId-1534951][bookmark: 43286]Verifyin[bookmark: marker-1534948]g Chec[bookmark: ChecksumMode]ksums
 
    [bookmark: pgfId-1557519]License: Protection
 
    [bookmark: pgfId-1530842]The system can verify all protocol-level checksums to ensure that complete IP, TCP, UDP, and ICMP transmissions are received and that, at a basic level, packets have not been tampered with or accidentally altered in transit. A checksum uses an algorithm to verify the integrity of a protocol in the packet. The packet is considered to be unchanged if the system computes the same value that is written in the packet by the end host.
 
    [bookmark: pgfId-1530843]Disabling checksum verification may leave your network susceptible to insertion attacks. Note that the system does not generate checksum verification events. In an inline deployment, you can configure the system to drop packets with invalid checksums.
 
    [bookmark: pgfId-1530844]To configure checksum verifications:
 
    [bookmark: pgfId-1550765]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1585761]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1585762]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1533377]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1533381]The Edit Policy page appears.
 
    [bookmark: pgfId-1533383]Step 3 [bookmark: 34131]Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1530859]The Settings page appears.
 
    [bookmark: pgfId-1530860]Step 4 You have two choices, depending on whether Checksum Verification under Transport/Network Layer Preprocessors is enabled:
 
     
      
      	 [bookmark: pgfId-1530861]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1530862]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1530863]The Checksum Verification page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1530867]Step 5 You can set any of the options in the Checksum Verification section to Enabled or Disabled in a passive or inline deployment, or to Drop in an inline deployment:
 
     
      
      	 [bookmark: pgfId-1530868] ICMP Checksums 
 
      	 [bookmark: pgfId-1530869] IP Checksums 
 
      	 [bookmark: pgfId-1530870] TCP Checksums 
 
      	 [bookmark: pgfId-1530871] UDP Checksums 
 
     
 
    
 
    [bookmark: pgfId-1530872]Note that to drop offending packets, in addition to setting an option to Drop you must also enable Inline Mode in the associated network analysis policy. See Allowing Preprocessors to Affect Traffic in Inline Deployments for more information. Note also that setting these options to Drop in a passive deployment, or in an inline deployment in tap mode, is the same as setting them to Enabled.
 
    [bookmark: pgfId-1576792]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1564364]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535308][bookmark: 39399][bookmark: 43997]Normaliz[bookmark: marker-1535305]ing In[bookmark: marker-1535306]lin[bookmark: marker-1535307]e Traffic
 
    [bookmark: pgfId-1557498]License: Protection
 
    [bookmark: pgfId-1530939]The inline normalization preprocessor normalizes traffic to minimize the chances of attackers evading detection in inline deployments. If you enable the inline normalization preprocessor in a network analysis policy, the system tests the following two conditions to ensure that you are using an inline deployment:
 
     
     	 [bookmark: pgfId-1530940] Inline Mode is enabled in the policy. See Allowing Preprocessors to Affect Traffic in Inline Deployments.
 
     	 [bookmark: pgfId-1530941]The access control policy where inline normalization is enabled is applied to a device that is deployed inline and uses an inline set.
 
    
 
    [bookmark: pgfId-1530942]The preprocessor normalizes specified traffic only when both conditions are met.
 
    [bookmark: pgfId-1530943]You can specify normalization of any combination of IPv4, IPv6, ICMPv4, ICMPv6, and TCP traffic. Most normalizations are on a per-packet basis and are conducted by the inline normalization preprocessor. However, the TCP stream preprocessor handles most state-related packet and stream normalizations, including TCP payload normalization.
 
    [bookmark: pgfId-1530944]Inline normalization takes place immediately after decoding by the packet decoder and before processing by other preprocessors. Normalization proceeds from the inner to outer packet layers.
 
    [bookmark: pgfId-1530945]The inline normalization preprocessor does not generate events; it prepares packets for use by other preprocessors and the rules engine in inline deployments. The preprocessor also helps ensure that the packets the system processes are the same as the packets received by the hosts on your network.
 
     
      
    
 
    
 
    [bookmark: pgfId-1530949]Tip In an inline deployment, Cisco recommends that you configure the inline normalization preprocessor with the Normalize TCP Payload option enabled. In a passive deployment, Cisco recommends that you configure adaptive profiles. For more information, see Tuning Preprocessing in Passive Deployments.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1540845]Minimum TTL
 
    [bookmark: pgfId-1531105]When Reset TTL is greater than or equal to the value 1 to 255 set for this option, specifies the following:
 
     
      
      	 [bookmark: pgfId-1531106]the minimum value the system will permit in the IPv4 Time to Live (TTL) field when  Normalize IPv4 is enabled; a lower value results in normalizing the packet value for TTL to the value set for  Reset TTL 
 
      	 [bookmark: pgfId-1531107]the minimum value the system will permit in the IPv6 Hop Limit field when  Normalize IPv6 is enabled; a lower value results in normalizing the packet value for Hop Limit to the value set for  Reset TTL 
 
     
 
    
 
    [bookmark: pgfId-1531108]The system assumes a value of 1 when the field is empty.
 
    [bookmark: pgfId-1531109]Note that you can enable the following rules in the decoder rule category to generate events for this option:
 
     
      
      	 [bookmark: pgfId-1531110]You can enable rule 116:428 to generate an event when the system detects an IPv4 packet with a TTL less than the specified minimum.
 
      	 [bookmark: pgfId-1531111]You can enable rule 116:270 to generate an event when the system detects an IPv6 packet with a hop limit that is less than the specified minimum.
 
     
 
    
 
    [bookmark: pgfId-1531114]See the packet decoder Detect Protocol Header Anomalies option in Configuring Packet Decoding for more information.
 
    [bookmark: pgfId-1531116]Reset TTL
 
    [bookmark: pgfId-1531117]When set to a value 1 to 255 that is greater than or equal to Minimum TTL, normalizes the following:
 
     
      
      	 [bookmark: pgfId-1531118]the IPv4 TTL field when  Normalize IPv4 is enabled
 
      	 [bookmark: pgfId-1531119]the IPv6 Hop Limit field when  Normalize IPv6 is enabled
 
     
 
    
 
    [bookmark: pgfId-1531120]The system normalizes the packet by changing its TTL or Hop Limit value to the value set for this option when the packet value is less than Minimum TTL. Setting this option to a value of 0, or any value less than Minimum TTL, disables the option. The system assumes a value of 0 when the field is empty.
 
    [bookmark: pgfId-1531121]Normalize IPv4
 
    [bookmark: pgfId-1538686]Enables normalization of IPv4 traffic. The system also normalizes the TTL field as needed when this option is enabled and the value set for Reset TTL enables TTL normalization. You can also enable Normalize Don’t Fragment Bits and Normalize Reserved Bits when this option is enabled.
 
    [bookmark: pgfId-1538832]When you enable this option, the system performs the following base IPv4 normalizations:
 
     
      
      	 [bookmark: pgfId-1538833]truncates packets with excess payload to the datagram length specified in the IP header
 
      	 [bookmark: pgfId-1538834]clears the Differentiated Services (DS) field, formerly known as the Type of Service (TOS) field
 
      	 [bookmark: pgfId-1538835]sets all option octets to 1 (No Operation)
 
     
 
    
 
    [bookmark: pgfId-1538687]Normalize Don't Fragment Bit
 
    [bookmark: pgfId-1531127]Clears the single-bit Don’t Fragment subfield of the IPv4 Flags header field. Enabling this option allows a downstream router to fragment packets if necessary instead of dropping them; enabling this option can also prevent evasions based on crafting packets to be dropped. You must enable Normalize IPv4 to select this option.
 
    [bookmark: pgfId-1531128]Normalize Reserved Bit
 
    [bookmark: pgfId-1540113]Clears the single-bit Reserved subfield of the IPv4 Flags header field. You would typically enable this option. You must enable Normalize IPv4 to select this option.
 
    [bookmark: pgfId-1540114]Normalize TOS Bit
 
    [bookmark: pgfId-1540115]Clears the one byte Differentiated Services field, formerly known as Type of Service. You must enable Normalize IPv4 to select this option.
 
    [bookmark: pgfId-1531132]Normalize Excess Payload
 
    [bookmark: pgfId-1531133]Truncates packets with excess payload to the datagram length specified in the IP header plus the Layer 2 (for example, Ethernet) header, but does not truncate below the minimum frame length. You must enable Normalize IPv4 to select this option.
 
    [bookmark: pgfId-1531134]Normalize IPv6
 
    [bookmark: pgfId-1531135]Sets all Option Type fields in the Hop-by-Hop Options and Destination Options extension headers to 00 (Skip and continue processing). The system also normalizes the Hop Limit field as needed when this option is enabled and the value set for Reset TTL enables hop limit normalization.
 
    [bookmark: pgfId-1531136]Normalize ICMPv4
 
    [bookmark: pgfId-1531137]Clears the 8-bit Code field in Echo (Request) and Echo Reply messages in ICMPv4 traffic.
 
    [bookmark: pgfId-1531138]Normalize ICMPv6
 
    [bookmark: pgfId-1531139]Clears the 8-bit Code field in Echo (Request) and Echo Reply messages in ICMPv6 traffic.
 
    [bookmark: pgfId-1541002]Normalize/Clear Reserved Bits
 
    [bookmark: pgfId-1541039]Clears the Reserved bits in the TCP header.
 
    [bookmark: pgfId-1542781]Normalize/Clear Option Padding Bytes
 
    [bookmark: pgfId-1542782]Clears any TCP option padding bytes.
 
    [bookmark: pgfId-1542786]Clear Urgent Pointer if URG=0
 
    [bookmark: pgfId-1542787]Clears the 16-bit TCP header Urgent Pointer field if the urgent (URG) control bit is not set.
 
    [bookmark: pgfId-1542788]Clear Urgent Pointer/URG on Empty Payload
 
    [bookmark: pgfId-1541754]Clears the TCP header Urgent Pointer field and the URG control bit if there is no payload.
 
    [bookmark: pgfId-1541758]Clear URG if Urgent Pointer is Not Set
 
    [bookmark: pgfId-1541759]Clears the TCP header URG control bit if the urgent pointer is not set.
 
    [bookmark: pgfId-1531148]Normalize Urgent Pointer
 
    [bookmark: pgfId-1545219]Sets the two-byte TCP header Urgent Pointer field to the payload length if the pointer is greater than the payload length.
 
    [bookmark: pgfId-1545208]Normalize TCP Payload
 
    [bookmark: pgfId-1531151]Enables normalization of the TCP Data field to ensure consistency in retransmitted data. Any segments that cannot be properly reassembled are dropped. 
 
    [bookmark: pgfId-1539541]Remove Data on SYN
 
    [bookmark: pgfId-1541311]Removes data in synchronization (SYN) packets if your TCP operating system policy is not Mac OS.
 
    [bookmark: pgfId-1544526]This option also disables event generation for rule 129:2.
 
    [bookmark: pgfId-1541371]Remove Data on RST
 
    [bookmark: pgfId-1541391]Removes any data from a TCP reset (RST) packet.
 
    [bookmark: pgfId-1541393]Trim Data to Window
 
    [bookmark: pgfId-1541420]Trims the TCP Data field to the size specified in the Window field.
 
    [bookmark: pgfId-1541422]Trim Data to MSS
 
    [bookmark: pgfId-1541440]Trims the TCP Data field to the Maximum Segment Size (MSS) if the payload is longer than MSS.
 
    [bookmark: pgfId-1541288]Block Unrecoverable TCP Header Anomalies
 
    [bookmark: pgfId-1539542]When you enable this option, the system blocks anomalous TCP packets that, if normalized, would be invalid and likely would be blocked by the receiving host. For example, the system blocks any SYN packet transmitted subsequent to an established session.
 
    [bookmark: pgfId-1566218]The system also drops any packet that matches any of the following TCP stream preprocessor rules, regardless of whether the rules are enabled:
 
    [bookmark: pgfId-1540090] – 129:1
 
    [bookmark: pgfId-1566115] – 129:3
 
    [bookmark: pgfId-1566132] – 129:4
 
    [bookmark: pgfId-1566135] – 129:6
 
    [bookmark: pgfId-1566138] – 129:8
 
    [bookmark: pgfId-1566141] – 129:11
 
    [bookmark: pgfId-1566213] – 129:14 through 129:19
 
    [bookmark: pgfId-1557132]The Total Blocked Packets performance graph tracks the number of packets blocked in inline deployments and, in passive deployments and inline deployments in tap mode, the number that would have been blocked in an inline deployment. See Generating Intrusion Event Performance Statistics Graphs for more information.
 
    [bookmark: pgfId-1540094]Explicit Congestion Notification
 
    [bookmark: pgfId-1540095]Enables per-packet or per-stream normalization of Explicit Congestion Notification (ECN) flags as follows:
 
     
      
      	 [bookmark: pgfId-1531161]select  Packet to clear ECN flags on a per-packet basis regardless of negotiation
 
      	 [bookmark: pgfId-1531162]select  Stream to clear ECN flags on a per-stream basis if ECN use was not negotiated
 
     
 
    
 
    [bookmark: pgfId-1531163]If you select Stream, you must also ensure that the TCP stream preprocessor Require TCP 3-Way Handshake option is enabled for this normalization to take place; see Selecting TCP Policy Options for more information. 
 
    [bookmark: pgfId-1531167]Allow These TCP Options
 
    [bookmark: pgfId-1531168]Disables normalization of specific TCP options you allow in traffic.
 
    [bookmark: pgfId-1531169]The system does not normalize options that you explicitly allow. It normalizes options that you do not explicitly allow by setting the options to No Operation (TCP Option 1).
 
    [bookmark: pgfId-1531170]The system always allows the Maximum Segment Size (MSS), Window Scale, and Time Stamp TCP options because these options are commonly used for optimal TCP performance. The system normalizes these commonly used options regardless of the configuration of Allow These TCP Options. The system does not automatically allow other less commonly used options.
 
    [bookmark: pgfId-1531174]You can allow specific options by configuring a comma-separated list of option keywords, option numbers, or both as shown in the following example:
 
     
     [bookmark: pgfId-1531175] sack, echo, 19 
    
 
    [bookmark: pgfId-1546089]Specifying an option keyword is the same as specifying the number for one or more TCP options associated with the keyword. For example, specifying sack is the same as specifying TCP options 4 (Selective Acknowledgment Permitted) and 5 (Selective Acknowledgment). Option keywords are not case sensitive. 
 
    [bookmark: pgfId-1546267]You can also specify any, which allows all TCP options and effectively disables normalization of all TCP options.
 
    [bookmark: pgfId-1531181]The following table summarizes how you can specify TCP options to allow. If you leave the field empty, the system allows only the MSS, Window Scale, and Time Stamp options.
 
    [bookmark: pgfId-1531219]
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1531184]Specify... 
         
  
        	 
          
          [bookmark: pgfId-1531186]To allow... 
         
  
       
 
        
        	[bookmark: pgfId-1531188]sack
  
        	[bookmark: pgfId-1531190]TCP options 4 (Selective Acknowledgment Permitted) and 5 (Selective Acknowledgment)
  
       
 
        
        	[bookmark: pgfId-1531192]echo
  
        	[bookmark: pgfId-1531194]TCP options 6 (Echo Request) and 7 (Echo Reply)
  
       
 
        
        	[bookmark: pgfId-1531196]partial_order
  
        	[bookmark: pgfId-1531198]TCP options 9 (Partial Order Connection Permitted) and 10 (Partial Order Service Profile)
  
       
 
        
        	[bookmark: pgfId-1531200]conn_count
  
        	[bookmark: pgfId-1531202]TCP Connection Count options 11 (CC), 12 (CC.New), and 13 (CC.Echo)
  
       
 
        
        	[bookmark: pgfId-1531204]alt_checksum
  
        	[bookmark: pgfId-1531206]TCP options 14 (Alternate Checksum Request) and 15 (Alternate Checksum)
  
       
 
        
        	[bookmark: pgfId-1531208]md5
  
        	[bookmark: pgfId-1531210]TCP option 19 (MD5 Signature)
  
       
 
        
        	[bookmark: pgfId-1531212]the option number, 2 to 255
  
        	[bookmark: pgfId-1531214]a specific option, including options for which there is no keyword
  
       
 
        
        	[bookmark: pgfId-1531216]any
  
        	[bookmark: pgfId-1531218]all TCP options; this setting effectively disables TCP option normalization
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1539790]When you do not specify any for this option, normalizations include the following:
 
     
     	 [bookmark: pgfId-1539791]except MSS, Window Scale, Time Stamp, and any explicitly allowed options, sets all option bytes to No Operation (TCP Option 1)
 
     	 [bookmark: pgfId-1539792]sets the Time Stamp octets to No Operation if Time Stamp is present but invalid, or valid but not negotiated
 
     	 [bookmark: pgfId-1539793]blocks the packet if Time Stamp is negotiated but not present
 
     	 [bookmark: pgfId-1539794]clears the Time Stamp Echo Reply (TSecr) option field if the Acknowledgment (ACK) control bit is not set
 
     	 [bookmark: pgfId-1551627]sets the MSS and Window Scale options to No Operation (TCP Option 1) if the SYN control bit is not set
 
    
 
    [bookmark: pgfId-1551628]To configure the inline normalizations preprocessor:
 
    [bookmark: pgfId-1585813]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1585840]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1585841]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1543741]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1543745]The Edit Policy page appears.
 
    [bookmark: pgfId-1543747]Step 3 Click Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1543748]The Settings page appears.
 
    [bookmark: pgfId-1531236]Step 4 You have two choices depending on whether Inline Normalization is enabled under Transport/Network Layer Preprocessors:
 
     
      
      	 [bookmark: pgfId-1531237]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1531238]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1531239]The Inline Normalization page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1531245]Step 5 You can set any of the options described in Normalizing Inline Traffic.
 
    [bookmark: pgfId-1531247]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1564552]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1531254][bookmark: 35118]Defr[bookmark: marker-1531252]agm[bookmark: IPDefragmentation]enting IP Packets
 
    [bookmark: pgfId-1557477]License: Protection
 
    [bookmark: pgfId-1531260]When an IP datagram is broken into two or more smaller IP datagrams because it is larger than the [bookmark: marker-1531261]maximum transmission unit (MTU), it is fragmented. A single IP datagram fragment may not contain enough information to identify a hidden attack. Attackers may attempt to evade detection by transmitting attack data in fragmented packets. The IP defragmentation preprocessor reassembles fragmented IP datagrams before the rules engine executes rules against them so the rules can more appropriately identify attacks in those packets. If fragmented datagrams cannot be reassembled, rules do not execute against them.
 
    [bookmark: pgfId-1531262]Note that you must enable IP defragmentation preprocessor rules, which have a generator ID (GID) of 123, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531266]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531270]Understanding IP Fragmentation Exploits
 
     	 [bookmark: pgfId-1531274]Target-Based Defragmentation Policies
 
     	 [bookmark: pgfId-1531278]Selecting Defragmentation Options
 
     	 [bookmark: pgfId-1531282]Configuring IP Defragmentation
 
    
 
     
      [bookmark: pgfId-1531285][bookmark: 17376]Unders[bookmark: marker-1531284]tanding IP Fragmentation Exploits
 
     [bookmark: pgfId-1557459]License: Protection
 
     [bookmark: pgfId-1531290]Enabling IP defragmentation helps you detect attacks against hosts on your network, like the teardrop attack, and resource consumption attacks against the system itself, like the Jolt2 attack.
 
     [bookmark: pgfId-1531291]The Teardrop attack exploits a bug in certain operating systems that causes them to crash when trying to reassemble overlapping IP fragments. When enabled and configured to do so, the IP defragmentation preprocessor identifies the overlapping fragments. The IP defragmentation preprocessor detects the first packets in an overlapping fragment attack such as Teardrop, but does not detect subsequent packets for the same attack.
 
     [bookmark: pgfId-1531292]The Jolt2 attack sends a large number of copies of the same fragmented IP packet in an attempt to overuse IP defragmentors and cause a denial of service attack. A memory usage cap disrupts this and similar attacks in the IP defragmentation preprocessor, and places the system self-preservation above exhaustive inspection. The system is not overwhelmed by the attack, remains operational, and continues to inspect network traffic.
 
     [bookmark: pgfId-1531293]Different operating systems reassemble fragmented packets in different ways. Attackers who can determine which operating systems your hosts are running can also fragment malicious packets so that a target host reassembles them in a specific manner. Because the system does not know which operating systems the hosts on your monitored network are running, the preprocessor may reassemble and inspect the packets incorrectly, thus allowing an exploit to pass through undetected. To mitigate this kind of attack, you can configure the defragmentation preprocessor to use the appropriate method of defragmenting packets for each host on your network. See Target-Based Defragmentation Policies for more information.
 
     [bookmark: pgfId-1531297]Note that you can also use adaptive profiles to dynamically select target-based policies for the IP defragmentation preprocessor using host operating system information for the target host in a packet. For more information, see Tuning Preprocessing in Passive Deployments.
 
    
 
     
      [bookmark: pgfId-1531303][bookmark: 27446]Target-Based Defragmentation[bookmark: marker-1531302] Policies
 
     [bookmark: pgfId-1557441]License: Protection
 
     [bookmark: pgfId-1531308]A host's operating system uses three criteria to determine which packet fragments to favor when reassembling the packet: the order in which the fragment was received by the operating system, its offset (the fragment's distance, in bytes, from the beginning of the packet), and its beginning and ending position compared to overlap fragments. Although every operating system uses these criteria, different operating systems favor different fragments when reassembling fragmented packets. Therefore, two hosts with different operating systems on your network could reassemble the same overlapping fragments in entirely different ways.
 
     [bookmark: pgfId-1531309]An attacker, aware of the operating system of one of your hosts, could attempt to evade detection and exploit that host by sending malicious content hidden in overlapping packet fragments. This packet, when reassembled and inspected, seems innocuous, but when reassembled by the target host, contains a malicious exploit. However, if you configure the IP defragmentation preprocessor to be aware of the operating systems running on your monitored network segment, it will reassemble the fragments the same way that the target host does, allowing it to identify the attack.
 
     [bookmark: pgfId-1531310]You can configure the IP defragmentation preprocessor to use one of seven defragmentation policies, depending on the operating system of the target host. The following table lists the seven policies and the operating systems that use each one. The First and Last policy names reflect whether those policies favor original or subsequent overlapping packets. 
 
     [bookmark: pgfId-1531360]
 
      
       
        
        [bookmark: pgfId-1531320]Table 29-1 [bookmark: 98686]Target-Based Defragmentation Policies 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531324]Policy 
          
  
         	 
           
           [bookmark: pgfId-1531326]Operating Systems 
          
  
        
 
         
         	[bookmark: pgfId-1531328]BSD
  
         	[bookmark: pgfId-1531330]AIX
 [bookmark: pgfId-1531331]FreeBSD
 [bookmark: pgfId-1531332]IRIX
 [bookmark: pgfId-1531333]VAX/VMS
  
        
 
         
         	[bookmark: pgfId-1531335]BSD-right
  
         	[bookmark: pgfId-1531337]HP JetDirect 
  
        
 
         
         	[bookmark: pgfId-1531339]First
  
         	[bookmark: pgfId-1531341]Mac OS
 [bookmark: pgfId-1531342]HP-UX
  
        
 
         
         	[bookmark: pgfId-1531344]Linux
  
         	[bookmark: pgfId-1531346]Linux
 [bookmark: pgfId-1531347]OpenBSD
  
        
 
         
         	[bookmark: pgfId-1531349]Last
  
         	[bookmark: pgfId-1531351]Cisco IOS
  
        
 
         
         	[bookmark: pgfId-1531353]Solaris
  
         	[bookmark: pgfId-1531355]SunOS
  
        
 
         
         	[bookmark: pgfId-1531357]Windows
  
         	[bookmark: pgfId-1531359]Windows
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1531363][bookmark: 65359]Selecting [bookmark: IP defragmentation]Defragmentation Options
 
     [bookmark: pgfId-1557419]License: Protection
 
     [bookmark: pgfId-1531371]You can choose to simply enable or disable IP defragmentation; however, Cisco recommends that you specify the behavior of the enabled IP defragmentation preprocessor at a more granular level.
 
     [bookmark: pgfId-1531372]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1531373]You can configure the global Preallocated Fragments option:
 
     [bookmark: pgfId-1531374]Preallocated Fragments
 
     [bookmark: pgfId-1531375]The maximum number of individual fragments that the preprocessor can process at once. Specifying the number of fragment nodes to preallocate enables static memory allocation.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1531376] 
      Caution Processing an individual fragment uses approximately 1550 bytes of memory. If the preprocessor requires more memory to process the individual fragments than the predetermined allowable memory limit for the managed device, the memory limit for the device takes precedence. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1531377]You can configure the following options for each IP defragmentation policy:
 
     [bookmark: pgfId-1531378]Networks
 
     [bookmark: pgfId-1531379]The IP address of the host or hosts to which you want to apply the defragmentation policy.
 
     [bookmark: pgfId-1531380]You can specify a single IP address or address block, or a comma-separated list of either or both. You can specify up to 255 total profiles, including the default policy. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1531387]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1583674]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1531388]Policy
 
     [bookmark: pgfId-1531389]The defragmentation policy you want to use for a set of hosts on your monitored network segment. You can choose among seven policies: BSD, BSD-Right, First, Linux, Last, Solaris, and Windows. See Target-Based Defragmentation Policies for detailed information on these policies.
 
     [bookmark: pgfId-1531394][bookmark: marker-1531393]Timeout
 
     [bookmark: pgfId-1531395]Specifies the maximum amount of time, in seconds, that the preprocessor engine can use when reassembling a fragmented packet. If the packet cannot be reassembled within the specified time period, the preprocessor engine stops attempting to reassemble the packet and discards received fragments.
 
     [bookmark: pgfId-1531396]Minimum TTL
 
     [bookmark: pgfId-1531397]Specifies the minimum acceptable TTL value a packet may have. This option detects TTL-based insertion attacks.
 
     [bookmark: pgfId-1531400]You can enable rule 123:1 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531402]Detect Anomalies
 
     [bookmark: pgfId-1531403]Identifies fragmentation problems such as overlapping fragments.
 
     [bookmark: pgfId-1531404]You can enable the following rules to generate events for this option:
 
      
       
       	 [bookmark: pgfId-1531405]123:1 through 123:4
 
       	 [bookmark: pgfId-1531406]123:5 (BSD policy)
 
       	 [bookmark: pgfId-1531407]123:6 through 123:8
 
      
 
     
 
     [bookmark: pgfId-1531408]Overlap Limit
 
     [bookmark: pgfId-1531409]Specifies that when the configured number between 0 (unlimited) and 255 of overlapping segments in a session has been detected, defragmentation stops for that session. You must enable Detect Anomalies to configure this option. A blank value disables this option.
 
     [bookmark: pgfId-1531412]You can enable rule 123:12 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531414]Minimum Fragment Size
 
     [bookmark: pgfId-1531415]Specifies that when a non-last fragment smaller than the configured number between 0 (unlimited) and 255 of bytes has been detected, the packet is considered malicious. You must enable Detect Anomalies to configure this option. A blank value disables this option.
 
     [bookmark: pgfId-1531418]You can enable rule 123:13 to generate events for this option. See Setting Rule States for more information.
 
    
 
     
      [bookmark: pgfId-1531423][bookmark: 60541]Configuring [bookmark: marker-1531421]IP Defragmentation
 
     [bookmark: pgfId-1557401]License: Protection
 
     [bookmark: pgfId-1531428]You can use the following procedure to configure the IP defragmentation preprocessor. For more information on the IP defragmentation preprocessor configuration options, see Selecting Defragmentation Options.
 
     [bookmark: pgfId-1531432]To configure IP defragmentation:
 
     [bookmark: pgfId-1550780]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1585871]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1585872]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1544007]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1544011]The Edit Policy page appears.
 
     [bookmark: pgfId-1544012]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1544013]The Settings page appears.
 
     [bookmark: pgfId-1531448]Step 4 You have two choices, depending on whether IP Defragmentation under Transport/Network Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1531449]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1531450]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1574625]The IP Defragmentation page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1531455]Step 5 Optionally, you can modify the setting for Preallocated Fragments in the Global Settings page area.
 
     [bookmark: pgfId-1531456]Step 6 You have two options:
 
      
       
       	 [bookmark: pgfId-1531460]Add a new target-based policy. Click the add icon (
 
      
 
      [image: ] ) next to 
       Servers on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses in the 
       Host Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1531461]You can specify a single IP address or address block, or a comma-separated list of either or both. You can create a total of 255 target-based policies including the default policy. For information on using IP address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1583689]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1531468]A new entry appears in the list of targets on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the policy you added.
 
      
       
       	 [bookmark: pgfId-1531469]Modify the settings for an existing target-based policy. Click the configured address for a policy you have added under  Hosts on the left side of the page, or click  default .
 
      
 
     
 ) next to the policy you want to remove. 
     
 
     [bookmark: pgfId-1531474]Step 7 Optionally, you can modify any of the options in the Configuration page area.
 
     [bookmark: pgfId-1531477]Step 8 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1564625]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1531485][bookmark: 48919]Understandin[bookmark: Decoding]g Pa[bookmark: marker-1531483]cket D[bookmark: marker-1531484]ecoding
 
    [bookmark: pgfId-1531490]License: Protection
 
    [bookmark: pgfId-1531491]Before sending captured packets to a preprocessor, the system first sends the packets to the packet decoder. The packet decoder converts packet headers and payloads into a format that preprocessors and the rules engine can easily use. Each stack layer is decoded in turn, beginning with the data link layer and continuing through the network and transport layers..
 
    [bookmark: pgfId-1531495]Note that you must enable packet decoder rules, which have a generator ID (GID) of 116, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531499]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
    [bookmark: pgfId-1531500]Decode GTP Data Channel
 
    [bookmark: pgfId-1531501]Decodes the encapsulated GTP (General Packet Radio Service [GPRS] Tunneling Protocol) data channel. By default, the decoder decodes version 0 data on port 3386 and version 1 data on port 2152. You can use the GTP_PORTS default variable to modify the ports that identify encapsulated GTP traffic. See Optimizing Predefined Default Variables for more information.
 
    [bookmark: pgfId-1531505]You can enable rules 116:297 and 116:298 to generate events for this option.
 
    [bookmark: pgfId-1531509][bookmark: 73808]Detect Tere[bookmark: marker-1531507]d[bookmark: marker-1531508]o on Non-Standard Ports
 
    [bookmark: pgfId-1531510]Inspects Teredo tunneling of IPv6 traffic that is identified on a UDP port other than port 3544.
 
    [bookmark: pgfId-1531511]The system always inspects IPv6 traffic when it is present. By default, IPv6 inspection includes the 4in6, 6in4, 6to4, and 6in6 tunneling schemes, and also includes Teredo tunneling when the UDP header specifies port 3544.
 
    [bookmark: pgfId-1531512]In an IPv4 network, IPv4 hosts can use the Teredo protocol to tunnel IPv6 traffic through an IPv4 Network Address Translation (NAT) device. Teredo encapsulates IPv6 packets within IPv4 UDP datagrams to permit IPv6 connectivity behind an IPv4 NAT device. The system normally uses UDP port 3544 to identify Teredo traffic. However, an attacker could use a non-standard port in an attempt to avoid detection. You can enable Detect Teredo on Non-Standard Ports to cause the system to inspect all UDP payloads for Teredo tunneling.
 
    [bookmark: pgfId-1531513]Teredo decoding occurs only on the first UDP header, and only when IPv4 is used for the outer network layer. When a second UDP layer is present after the Teredo IPv6 layer because of UDP data encapsulated in the IPv6 data, the rules engine uses UDP intrusion rules to analyze both the inner and outer UDP layers. 
 
    [bookmark: pgfId-1531514]Note that intrusion rules 12065, 12066, 12067, and 12068 in the policy-other rule category detect, but do not decode, Teredo traffic. Optionally, you can use these rules to drop Teredo traffic in an inline deployment; however, you should ensure that these rules are disabled or set to generate events without dropping traffic when you enable Detect Teredo on Non-Standard Ports. See Filtering Rules in an Intrusion Policy and Setting Rule States for more information.
 
    [bookmark: pgfId-1531522]Detect Exces[bookmark: marker-1531521]sive Length Value 
 
    [bookmark: pgfId-1531523]Detects when the packet header specifies a packet length that is greater than the actual packet length.
 
    [bookmark: pgfId-1531524]You can enable rules 116:6, 116:47, 116:97, and 116:275 to generate events for this option.
 
    [bookmark: pgfId-1531527][bookmark: 75775]Detect Invali[bookmark: marker-1531526]d IP Options 
 
    [bookmark: pgfId-1531528]Detects invalid IP header options to identify exploits that use invalid IP options. For example, there is a denial of service attack against a firewall which causes the system to freeze. The firewall attempts to parse invalid Timestamp and Security IP options and fails to check for a zero length, which causes an irrecoverable infinite loop. The rules engine identifies the zero length option, and provides information you can use to mitigate the attack at the firewall.
 
    [bookmark: pgfId-1531529]You can enable rules 116:4 and 116:5 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531536][bookmark: 73685]Detect Experi[bookmark: marker-1531534]mental[bookmark: marker-1531535] TCP Options
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1531540]TCP Option 
         
  
        	 
          
          [bookmark: pgfId-1531542]Description 
         
  
       
 
        
        	[bookmark: pgfId-1531544]9
  
        	[bookmark: pgfId-1531546]Partial Order Connection Permitted
  
       
 
        
        	[bookmark: pgfId-1531548]10
  
        	[bookmark: pgfId-1531550]Partial Order Service Profile
  
       
 
        
        	[bookmark: pgfId-1531552]14
  
        	[bookmark: pgfId-1531554]Alternate Checksum Request
  
       
 
        
        	[bookmark: pgfId-1531556]15
  
        	[bookmark: pgfId-1531558]Alternate Checksum Data
  
       
 
        
        	[bookmark: pgfId-1531560]18
  
        	[bookmark: pgfId-1531562]Trailer Checksum
  
       
 
        
        	[bookmark: pgfId-1531564]20
  
        	[bookmark: pgfId-1531566]Space Communications Protocol Standards (SCPS)
  
       
 
        
        	[bookmark: pgfId-1531568]21
  
        	[bookmark: pgfId-1531570]Selective Negative Acknowledgements (SCPS)
  
       
 
        
        	[bookmark: pgfId-1531572]22
  
        	[bookmark: pgfId-1531574]Record Boundaries (SCPS)
  
       
 
        
        	[bookmark: pgfId-1531576]23
  
        	[bookmark: pgfId-1531578]Corruption (SPCS)
  
       
 
        
        	[bookmark: pgfId-1531580]24
  
        	[bookmark: pgfId-1531582]SNAP
  
       
 
        
        	[bookmark: pgfId-1531584]26
  
        	[bookmark: pgfId-1531586]TCP Compression Filter
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531588]Because these are experimental options, some systems do not account for them and may be open to exploits.
 
     
      
    
 
    
 
    [bookmark: pgfId-1531589]Note In addition to the experimental options listed in the above table, the system considers any TCP option with an option number greater than 26 to be experimental.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1531592]You can enable rule 116:58 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531597][bookmark: 91074]Detect Obs[bookmark: marker-1531595]ole[bookmark: marker-1531596]te TCP Options
 
     
      
       
        
        	 
          
          [bookmark: pgfId-1531601]TCP Option 
         
  
        	 
          
          [bookmark: pgfId-1531603]Description 
         
  
       
 
        
        	[bookmark: pgfId-1531605]6
  
        	[bookmark: pgfId-1531607]Echo
  
       
 
        
        	[bookmark: pgfId-1531609]7
  
        	[bookmark: pgfId-1531611]Echo Reply
  
       
 
        
        	[bookmark: pgfId-1531613]16
  
        	[bookmark: pgfId-1531615]Skeeter
  
       
 
        
        	[bookmark: pgfId-1531617]17
  
        	[bookmark: pgfId-1531619]Bubba
  
       
 
        
        	[bookmark: pgfId-1531621]19
  
        	[bookmark: pgfId-1531623]MD5 Signature
  
       
 
        
        	[bookmark: pgfId-1531625]25
  
        	[bookmark: pgfId-1531627]Unassigned
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531631]You can enable rule 116:57 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531636][bookmark: 37250]Dete[bookmark: marker-1531634]ct T/T[bookmark: marker-1531635]CP
 
    [bookmark: pgfId-1531637]Detects TCP headers with the CC.ECHO option. The CC.ECHO option confirms that TCP for Transactions (T/TCP) is being used. Because T/TCP header options are not in widespread use, some systems do not account for them and may be open to exploits.
 
    [bookmark: pgfId-1531640]You can enable rule 116:56 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531644][bookmark: 10463]Detect Other T[bookmark: marker-1531643]CP Options
 
    [bookmark: pgfId-1531645]Detects TCP headers with invalid TCP options not detected by other TCP decoding event options. For example, this option detects TCP options with the incorrect length or with a length that places the option data outside the TCP header.
 
    [bookmark: pgfId-1531646]You can enable rules 116:54, 116:55, and 116:59 to generate events for this option. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531652][bookmark: 74683]Detect Protocol Header Anom[bookmark: marker-1531651]alies
 
    [bookmark: pgfId-1531653]Detects other decoding errors not detected by the more specific IP and TCP decoder options. For example, the decoder might detect a malformed data-link protocol header.
 
    [bookmark: pgfId-1531654]To generate events for this option, you can enable any packet decoder rule other than rules specifically associated with other packet decoder options. See Setting Rule States for more information
 
    [bookmark: pgfId-1531658]Note that the following rules generate events triggered by anomalous IPv6 traffic: 116:270 through 116:274, 116:275 through 116:283, 116:291, 116:292, 116:295, 116:296, 116:406, 116:458, 116:460, 116:461.
 
    [bookmark: pgfId-1531659]Note also the following rules associated with the inline normalization preprocessor Minimum TTL option:
 
     
      
      	 [bookmark: pgfId-1531660]You can enable rule 116:428 to generate an event when the system detects an IPv4 packet with a TTL less than the specified minimum.
 
      	 [bookmark: pgfId-1531661]You can enable rule 116:270 to generate an event when the system detects an IPv6 packet with a hop limit that is less than the specified minimum.
 
     
 
    
 
    [bookmark: pgfId-1531664]See the inline normalization Minimum TTL option in Normalizing Inline Traffic for more information.
 
     
      [bookmark: pgfId-1531669][bookmark: 42145]Configuring Packet [bookmark: marker-1531668]Decoding
 
     [bookmark: pgfId-1531673]License: Protection
 
     [bookmark: pgfId-1531674]You can configure packet decoding on the Packet Decoding configuration page. For more information on packet decoding configuration options, see Understanding Packet Decoding.
 
     [bookmark: pgfId-1531678]To configure packet decoding:
 
     [bookmark: pgfId-1533316]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1585885]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1585886]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1546662]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1546666]The Edit Policy page appears.
 
     [bookmark: pgfId-1546668]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1546669]The Settings page appears.
 
     [bookmark: pgfId-1531694]Step 4 You have two choices, depending on whether Packet Decoding under Transport/Network Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1531695]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1531696]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1531697]The Packet Decoding page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Resolving Conflicts and Committing Policy Changes for more information
 
     [bookmark: pgfId-1531701]Step 5 You can enable or disable any of the detection options on the Packet Decoding page. See Understanding Packet Decoding for more information.
 
     [bookmark: pgfId-1531707]Step 6 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1564640]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1531715][bookmark: 56264]Using TCP Str[bookmark: Stream(TCP)]eam Prepro[bookmark: marker-1531713]ces[bookmark: marker-1531714]sing
 
    [bookmark: pgfId-1531719]License: Protection
 
    [bookmark: pgfId-1531720]The TCP protocol defines various states in which connections can exist. Each TCP connection is identified by the source and destination IP addresses and source and destination ports. TCP permits only one connection with the same connection parameter values to exist at a time. 
 
    [bookmark: pgfId-1531721]Note that you must enable TCP stream preprocessor rules, which have a generator ID (GID) of 129, if you want these rules to generate events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1531743]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531747]Understanding State-Related TCP Exploits
 
     	 [bookmark: pgfId-1531751]Initiating Active Responses with Intrusion Drop Rules
 
     	 [bookmark: pgfId-1531755]Selecting The TCP Global Option
 
     	 [bookmark: pgfId-1531759]Understanding Target-Based TCP Policies
 
     	 [bookmark: pgfId-1531763]Selecting TCP Policy Options
 
     	 [bookmark: pgfId-1531767]Reassembling TCP Streams
 
     	 [bookmark: pgfId-1531771]Configuring TCP Stream Preprocessing
 
    
 
     
      [bookmark: pgfId-1531774][bookmark: 39970]Understanding State-Re[bookmark: marker-1531773]lated TCP Exploits
 
     [bookmark: pgfId-1531778]License: Protection
 
     [bookmark: pgfId-1531779]If you add the flow keyword with the established argument to an intrusion rule, the intrusion rules engine inspects packets matching the rule and the flow directive in stateful mode. Stateful mode evaluates only the traffic that is part of a TCP session established with a legitimate three-way handshake between a client and server. The following diagram illustrates a three-way handshake.
 
     [bookmark: pgfId-1598518]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531788]You can configure the system so that the preprocessor detects any TCP traffic that cannot be identified as part of an established TCP session, although this is not recommended for typical use because the events would quickly overload the system and not provide meaningful data.
 
     [bookmark: pgfId-1531789]Attacks like stick and snot use the system’s extensive rule sets and packet inspection against itself. These tools generate packets based on the patterns in Snort-based intrusion rules, and send them across the network. If your rules do not include the flow or flowbits keyword to configure them for stateful inspection, each packet will trigger the rule, overwhelming the system. Stateful inspection allows you to ignore these packets because they are not part of an established TCP session and do not provide meaningful information. When performing stateful inspection, the rules engine detects only those attacks that are part of an established TCP session, allowing analysts to focus on these rather than the volume of events caused by stick or snot.
 
    
 
     
      [bookmark: pgfId-1531822][bookmark: 62039]Sele[bookmark: marker-1531821]cting The TCP Global Option
 
     [bookmark: pgfId-1556954]License: Protection
 
     [bookmark: pgfId-1531827]The TCP stream preprocessor has one global option that controls how the TCP stream preprocessor functions.
 
     [bookmark: pgfId-1531828]No preprocessor rules are associated with this option.
 
     [bookmark: pgfId-1531830][bookmark: marker-1531829]Packet Type Performance Boost
 
     [bookmark: pgfId-1531831]Enables ignoring TCP traffic for all ports and application protocols that are not specified in enabled intrusion rules, except when a TCP rule with both the source and destination ports set to any has a flow or flowbits option. This performance improvement could result in missed attacks.
 
    
 
     
      [bookmark: pgfId-1531846][bookmark: 45662]Understanding Ta[bookmark: marker-1531845]rget-Based TCP Policies
 
     [bookmark: pgfId-1531850]License: Protection
 
     [bookmark: pgfId-1531851]Different operating systems implement TCP in different ways. For example, Windows and some other operating systems require a TCP reset segment to have a precise TCP sequence number to reset a session, while Linux and other operating systems permit a range of sequence numbers. In this example, the stream preprocessor must understand exactly how the destination host will respond to the reset based on the sequence number. The stream preprocessor stops tracking the session only when the destination host considers the reset to be valid, so an attack cannot evade detection by sending packets after the preprocessor stops inspecting the stream. Other variations in TCP implementations include such things as whether an operating system employs a TCP timestamp option and, if so, how it handles the timestamp, and whether an operating system accepts or ignores data in a SYN packet.
 
     [bookmark: pgfId-1531852]Different operating systems also reassemble overlapping TCP segments in different ways. Overlapping TCP segments could reflect normal retransmissions of unacknowledged TCP traffic. They could also represent an attempt by an attacker, aware of the operating system of one of your hosts, to evade detection and exploit that host by sending malicious content hidden in overlapping segments. However, you can configure the stream preprocessor to be aware of the operating systems running on your monitored network segment so it reassembles segments the same way the target host does, allowing it to identify the attack.
 
     [bookmark: pgfId-1531853]You can create one or more TCP policies to tailor TCP stream inspection and reassembly to the different operating systems on your monitored network segment. For each policy, you identify one of thirteen operating system policies. You bind each TCP policy to a specific IP address or address block using as many TCP policies as you need to identify any or all of the hosts using a different operating system. The default TCP policy applies to any hosts on the monitored network that you do not identify in any other TCP policy, so there is no need to specify an IP address, CIDR block, or prefix length for the default TCP policy.
 
     [bookmark: pgfId-1531854]Note that you can also use adaptive profiles to dynamically select target-based policies for the TCP stream preprocessor using host operating system information for the target host in a packet. For more information, see Tuning Preprocessing in Passive Deployments.
 
      
       
        
        [bookmark: pgfId-1531869]Table 29-2 [bookmark: 28246]TCP Operating System Policies 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531873]Policy 
          
  
         	 
           
           [bookmark: pgfId-1531875]Operating Systems 
          
  
        
 
         
         	[bookmark: pgfId-1531877]First
  
         	[bookmark: pgfId-1531879]unknown OS
  
        
 
         
         	[bookmark: pgfId-1531881]Last
  
         	[bookmark: pgfId-1531883]Cisco IOS
  
        
 
         
         	[bookmark: pgfId-1531885]BSD
  
         	[bookmark: pgfId-1531887]AIX
 [bookmark: pgfId-1531888]FreeBSD
 [bookmark: pgfId-1531889]OpenBSD
  
        
 
         
         	[bookmark: pgfId-1531891]Linux
  
         	[bookmark: pgfId-1531893]Linux 2.4 kernel
 [bookmark: pgfId-1531894]Linux 2.6 kernel
  
        
 
         
         	[bookmark: pgfId-1531896]Old Linux
  
         	[bookmark: pgfId-1531898]Linux 2.2 and earlier kernel
  
        
 
         
         	[bookmark: pgfId-1531900]Windows
  
         	[bookmark: pgfId-1531902]Windows 98
 [bookmark: pgfId-1531903]Windows NT
 [bookmark: pgfId-1531904]Windows 2000
 [bookmark: pgfId-1531905]Windows XP
  
        
 
         
         	[bookmark: pgfId-1531907]Windows 2003
  
         	[bookmark: pgfId-1531909]Windows 2003
  
        
 
         
         	[bookmark: pgfId-1531911]Windows Vista
  
         	[bookmark: pgfId-1531913]Windows Vista
  
        
 
         
         	[bookmark: pgfId-1531915]Solaris
  
         	[bookmark: pgfId-1531917]Solaris OS
 [bookmark: pgfId-1531918]SunOS
  
        
 
         
         	[bookmark: pgfId-1531920]IRIX
  
         	[bookmark: pgfId-1531922]SGI Irix
  
        
 
         
         	[bookmark: pgfId-1531924]HPUX
  
         	[bookmark: pgfId-1531926]HP-UX 11.0 and later
  
        
 
         
         	[bookmark: pgfId-1531928]HPUX 10
  
         	[bookmark: pgfId-1531930]HP-UX 10.2 and earlier
  
        
 
         
         	[bookmark: pgfId-1531932]Mac OS
  
         	[bookmark: pgfId-1531934]Mac OS 10 (Mac OS X)
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1577038]Tip The First operating system policy could offer some protection when you do not know the host operating system. However, it may result in missed attacks. You should edit the policy to specify the correct operating system if you know it.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1531938][bookmark: 21035]Selecting TCP P[bookmark: marker-1531937]olicy Options
 
     [bookmark: pgfId-1556975]License: Protection
 
     [bookmark: pgfId-1531943]The following list describes the options you can set to identify and control TCP traffic that the stream preprocessor inspects.
 
     [bookmark: pgfId-1531944]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1531946][bookmark: marker-1531945]Network
 
     [bookmark: pgfId-1531947]Specifies the host IP addresses to which you want to apply the TCP stream reassembly policy.
 
     [bookmark: pgfId-1531948]You can specify a single IP address or address block. You can specify up to 255 total profiles including the default policy. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1531955]Note that the default setting in the default policy specifies all IP addresses on your monitored network segment that are not covered by another target-based policy. Therefore, you cannot and do not need to specify an IP address or CIDR block/prefix length for the default policy, and you cannot leave this setting blank in another policy or use address notation to represent any (for example, 0.0.0.0/0 or ::/0).
 
     [bookmark: pgfId-1583733]Note also that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1531957][bookmark: marker-1531956]Policy
 
     [bookmark: pgfId-1531958]Identifies the TCP policy operating system of the target host or hosts. If you select a policy other than Mac OS, the system removes the data from the synchronization (SYN) packets and disables event generation for rule 129:2.
 
     [bookmark: pgfId-1531961]For more information, see Understanding Target-Based TCP Policies.
 
     [bookmark: pgfId-1531964][bookmark: marker-1531963]Timeout
 
     [bookmark: pgfId-1531965]The number of seconds between 1 and 86400 the intrusion rules engine keeps an inactive stream in the state table. If the stream is not reassembled in the specified time, the intrusion rules engine deletes it from the state table.
 
      
       
     
 
     
 
     [bookmark: pgfId-1531966]Note If your managed device is deployed on a segment where the network traffic is likely to reach the device’s bandwidth limits, you should consider setting this value higher (for example, to 600 seconds) to lower the amount of processing overhead.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1531968][bookmark: marker-1531967]Maximum TCP Window
 
     [bookmark: pgfId-1531969]Specifies the maximum TCP window size between 1 and 1073725440 bytes allowed as specified by a receiving host. Setting the value to 0 disables checking for the TCP window size.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1531970] 
      Caution The upper limit is the maximum window size permitted by RFC, and is intended to prevent an attacker from evading detection, but setting a significantly large maximum window size could result in a self-imposed denial of service. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1531973]You can enable rule 129:6 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531976][bookmark: marker-1531975]Overlap Limit
 
     [bookmark: pgfId-1531977]Specifies that when the configured number between 0 (unlimited) and 255 of overlapping segments in a session has been detected, segment reassembly stops for that session and, if Stateful Inspection Anomalies is enabled and the accompanying preprocessor rule is enabled, an event is generated.
 
     [bookmark: pgfId-1531980]You can enable rule 129:7 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1531983]Flu[bookmark: marker-1531982]sh Factor
 
     [bookmark: pgfId-1531984]In an inline deployment, specifies that when a segment of decreased size has been detected subsequent to the configured number between 1 and 2048 of segments of non-decreasing size, the system flushes segment data accumulated for detection. Setting the value to 0 disables detection of this segment pattern, which can indicate the end of a request or response. Note that the Inline Normalization Normalize TCP Payload option must be enabled for this option the be effective. See Normalizing Inline Traffic for more information.
 
     [bookmark: pgfId-1531989][bookmark: marker-1531988]Stateful Inspection Anomalies
 
     [bookmark: pgfId-1531990]Detects anomalous behavior in the TCP stack. When accompanying preprocessor rules are enabled, this may generate many events if TCP/IP stacks are poorly written.
 
     [bookmark: pgfId-1531991]You can enable the following rules to generate events for this option:
 
     [bookmark: pgfId-1531992] – 129:1 through 129:5
 
     [bookmark: pgfId-1531993] – 129:6 (Mac OS only)
 
     [bookmark: pgfId-1531994] – 129:8 through 129:11
 
     [bookmark: pgfId-1531995] – 129:13 through 129:19
 
     [bookmark: pgfId-1531999]See Setting Rule States for more information:
 
     [bookmark: pgfId-1532000]TCP Session Hijacking
 
     [bookmark: pgfId-1532001]Detects TCP session hijacking by validating the hardware (MAC) addresses detected from both sides of a TCP connection during the 3-way handshake against subsequent packets received on the session. When the MAC address for one side or the other does not match, if Stateful Inspection Anomalies is enabled and one of the two corresponding preprocessor rules are enabled, the system generates events. 
 
     [bookmark: pgfId-1532002]You can enable rules 129:9 and 129:10 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532007]Conse[bookmark: marker-1532006]cutive Small Segments
 
     [bookmark: pgfId-1532008]When Stateful Inspection Anomalies is enabled, specifies a maximum number of 1 to 2048 consecutive small TCP segments allowed. Setting the value to 0 disables checking for consecutive small segments.
 
     [bookmark: pgfId-1532009]You must set this option together with the Small Segment Size option, either disabling both or setting a non-zero value for both. Note that receiving as many as 2000 consecutive segments, even if each segment was 1 byte in length, without an intervening ACK would be far more consecutive segments than you would normally expect.
 
     [bookmark: pgfId-1532012]You can enable rule 129:12 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532015]Small Se[bookmark: marker-1532014]gment Size
 
     [bookmark: pgfId-1532016]When Stateful Inspection Anomalies is enabled, specifies the 1 to 2048 byte TCP segment size that is considered small. Setting the value to 0 disables specifying the size of a small segment.
 
     [bookmark: pgfId-1532017]You must set this option together with the Consecutive Small Segments option, either disabling both or setting a non-zero value for both. Note that a 2048 byte TCP segment is larger than a normal 1500 byte Ethernet frame.
 
     [bookmark: pgfId-1532019]Ports Ig[bookmark: marker-1532018]noring Small Segments
 
     [bookmark: pgfId-1532020]When Stateful Inspection Anomalies, Consecutive Small Segments, and Small Segment Size are enabled, optionally specifies a comma-separated list of one or more ports that ignore small TCP segment detection. Leaving this option blank specifies that no ports are ignored. 
 
     [bookmark: pgfId-1532021]You can add any port to the list, but the list only affects ports specified in one of the Perform Stream Reassembly on port lists in the TCP policy.
 
     [bookmark: pgfId-1532023][bookmark: marker-1532022]Require TCP 3-Way Handshake 
 
     [bookmark: pgfId-1532024]Specifies that sessions are treated as established only upon completion of a TCP three-way handshake. Disable this option to increase performance, protect from SYN flood attacks, and permit operation in a partially asynchronous environment. Enable it to avoid attacks that attempt to generate false positives by sending information that is not part of an established TCP session.
 
     [bookmark: pgfId-1532027]You can enable rule 129:20 to generate events for this option. See Setting Rule States for more information.
 
     [bookmark: pgfId-1532030][bookmark: marker-1532029]3-Way Handshake Timeout
 
     [bookmark: pgfId-1532031]Specifies the number of seconds between 0 (unlimited) and 86400 (twenty-four hours) by which a handshake must be completed when Require TCP 3-Way Handshake is enabled. You must enable Require TCP 3-Way Handshake to modify the value for this option.
 
     [bookmark: pgfId-1532033][bookmark: marker-1532032]Packet Size Performance Boost
 
     [bookmark: pgfId-1532034]Sets the preprocessor to not queue large packets in the reassembly buffer. This performance improvement could result in missed attacks. Disable this option to protect against evasion attempts using small packets of one to twenty bytes. Enable it when you are assured of no such attacks because all traffic is comprised of very large packets.
 
     [bookmark: pgfId-1532036][bookmark: marker-1532035]Legacy Reassembly
 
     [bookmark: pgfId-1532037]Sets the stream preprocessor to emulate the deprecated Stream 4 preprocessor when reassembling packets, which lets you compare events reassembled by the stream preprocessor to events based on the same data stream reassembled by the Stream 4 preprocessor.
 
     [bookmark: pgfId-1532039]Asyn[bookmark: marker-1532038]chronous Network
 
     [bookmark: pgfId-1532040]Specifies whether the monitored network is an asynchronous network, that is, a network where the system sees only half the traffic. When this option is enabled, the system does not reassemble TCP streams to increase performance. 
 
     [bookmark: pgfId-1532041]Perform Stream Reassembly on Client Ports, Server Ports, Both Ports
 
     [bookmark: pgfId-1532042]Specifies for client ports, server ports, or both, a comma-separated list of ports to identify the traffic for the stream preprocessor to reassemble. See Selecting Stream Reassembly Options.
 
     [bookmark: pgfId-1532046]Perform Stream Reassembly on Client Services, Server Services, Both Services
 
     [bookmark: pgfId-1532047]Specifies for client services, server services, or both, services to identify in the traffic for the stream preprocessor to reassemble. See Selecting Stream Reassembly Options.
 
     [bookmark: pgfId-1571300]Troubleshooting Options: Maximum Queued Bytes
 
     [bookmark: pgfId-1571608]Support might ask you during a troubleshooting call to specify the amount of data that can be queued on one side of a TCP connection. A value of 0 specifies an unlimited number of bytes.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1571436] 
      Caution Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1571324]Troubleshooting Options: Maximum Queued Segments
 
     [bookmark: pgfId-1571632]Support might ask you during a troubleshooting call to specify the maximum number of bytes of data segments that can be queued on one side of a TCP connection. A value of 0 specifies an unlimited number of data segment bytes.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1571401] 
      Caution Changing the setting for this troubleshooting option will affect performance and should be done only with Support guidance. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1532053][bookmark: 73650]Reas[bookmark: marker-1532052]sembling TCP Streams
 
     [bookmark: pgfId-1556993]License: Protection
 
     [bookmark: pgfId-1532058]The stream preprocessor collects and reassembles all the packets that are part of a TCP session’s server-to-client communication stream, client-to-server communication stream, or both. This allows the rules engine to inspect the stream as a single, reassembled entity rather than inspecting only the individual packets that are part of a given stream.
 
     [bookmark: pgfId-1532087]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1532091]Understanding Stream-Based Attacks
 
      	 [bookmark: pgfId-1532095]Selecting Stream Reassembly Options
 
     
 
    
 
     
      [bookmark: pgfId-1532098][bookmark: 77990]Understan[bookmark: marker-1532097]ding Stream-Based Attacks
 
     [bookmark: pgfId-1557011]License: Protection
 
     [bookmark: pgfId-1532103]Stream reassembly allows the rules engine to identify stream-based attacks, which it may not detect when inspecting individual packets. You can specify which communication streams the rules engine reassembles based on your network needs. For example, when monitoring traffic on your web servers, you may only want to inspect client traffic because you are much less likely to receive malicious traffic from your own web server.
 
    
 
     
      [bookmark: pgfId-1532106][bookmark: 52798]Selecting Stream R[bookmark: marker-1532105]eassembly Options
 
     [bookmark: pgfId-1557029]License: Protection
 
     [bookmark: pgfId-1532111]In each TCP policy, you can specify a comma-separated list of ports to identify the traffic for the stream preprocessor to reassemble. If adaptive profiles are enabled, you can also list services that identify traffic to reassemble, either as an alternative to ports or in combination with ports. See Tuning Preprocessing in Passive Deployments for information on enabling and using adaptive profiles. 
 
     [bookmark: pgfId-1532115]You can specify ports, services, or both. You can specify separate lists of ports for any combination of client ports, server ports, and both. You can also specify separate lists of services for any combination of client services, server services, and both. For example, assume that you wanted to reassemble the following:
 
      
      	 [bookmark: pgfId-1532116]SMTP (port 25) traffic from the client
 
      	 [bookmark: pgfId-1532117]FTP server responses (port 21)
 
      	 [bookmark: pgfId-1532118]telnet (port 23) traffic in both directions
 
     
 
     [bookmark: pgfId-1532119]You could configure the following:
 
      
      	 [bookmark: pgfId-1532120]For client ports, specify  23, 25 
 
      	 [bookmark: pgfId-1532121]For server ports, specify  21, 23 
 
     
 
     [bookmark: pgfId-1532122]Or, instead, you could configure the following:
 
      
      	 [bookmark: pgfId-1532123]For client ports, specify  25 
 
      	 [bookmark: pgfId-1532124]For server ports, specify  21 
 
      	 [bookmark: pgfId-1532125]For both ports, specify  23 
 
     
 
     [bookmark: pgfId-1532126]Additionally, consider the following example which combines ports and services and would be valid when adaptive profiles are enabled:
 
      
      	 [bookmark: pgfId-1532127]For client ports, specify  23 
 
      	 [bookmark: pgfId-1532128]For client services, specify  smtp 
 
      	 [bookmark: pgfId-1532129]For server ports, specify  21 
 
      	 [bookmark: pgfId-1532130]For server services, specify  telnet 
 
     
 
     [bookmark: pgfId-1532131]Negating a port (for example, !80) can improve performance by preventing the TCP stream preprocessor from processing traffic for that port.
 
     [bookmark: pgfId-1590597]Although you can also specify all as the argument to provide reassembly for all ports, Cisco does not recommend setting ports to all because it may increase the amount of traffic inspected by this preprocessor and slow performance unnecessarily.
 
     [bookmark: pgfId-1577101]TCP reassembly automatically and transparently includes ports that you add to other preprocessors. However, if you do explicitly add ports to TCP reassembly lists that you have added to other preprocessor configurations, these additional ports are handled normally. This includes port lists for the following preprocessors:
 
      
      	 [bookmark: pgfId-1584460]FTP/Telnet (server-level FTP)
 
      	 [bookmark: pgfId-1584464]DCE/RPC
 
      	 [bookmark: pgfId-1584468]HTTP Inspect
 
      	 [bookmark: pgfId-1584479]SMTP
 
      	 [bookmark: pgfId-1584482]Session Initiation Protocol
 
      	 [bookmark: pgfId-1584486]POP
 
      	 [bookmark: pgfId-1584489]IMAP
 
      	 [bookmark: pgfId-1584500]SSL
 
     
 
     [bookmark: pgfId-1584503]Note that reassembling additional traffic types (client, server, both) increases resource demands.
 
     [bookmark: pgfId-1532135]If no preprocessor rule is mentioned in the following descriptions, the option is not associated with a preprocessor rule.
 
     [bookmark: pgfId-1532137][bookmark: marker-1532136]Perform Stream Reassembly on Client Ports
 
     [bookmark: pgfId-1532138]Enables stream reassembly based on ports for the client side of the connection. In other words, it reassembles streams destined for web servers, mail servers, or other IP addresses typically defined by the IP addresses specified in $HOME_NET. Use this option when you expect malicious traffic to originate from clients.
 
     [bookmark: pgfId-1532140][bookmark: marker-1532139]Perform Stream Reassembly on Client Services
 
     [bookmark: pgfId-1532141]Enables stream reassembly based on services for the client side of the connection. Use this option when you expect malicious traffic to originate from clients.
 
     [bookmark: pgfId-1532144]At least one client detector must be enabled (see Activating and Deactivating Detectors) for each client service you select. By default, all Cisco-provided detectors are activated. If no detector is enabled for an associated client application, the system automatically enables all Cisco-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.
 
     [bookmark: pgfId-1532158]This feature requires Protection and Control licenses.
 
     [bookmark: pgfId-1532160][bookmark: marker-1532159]Perform Stream Reassembly on Server Ports
 
     [bookmark: pgfId-1532161]Enables stream reassembly based on ports for the server side of the connection only. In other words, it reassembles streams originating from web servers, mail servers, or other IP addresses typically defined by the IP addresses specified in $EXTERNAL_NET. Use this option when you want to watch for server side attacks. You can disable this option by not specifying ports.
 
     [bookmark: pgfId-1532163][bookmark: marker-1532162]Perform Stream Reassembly on Server Services
 
     [bookmark: pgfId-1532164]Enables stream reassembly based on services for the server side of the connection only. Use this option when you want to watch for server side attacks. You can disable this option by not specifying services.
 
     [bookmark: pgfId-1532167]At least one detector must be enabled (see Activating and Deactivating Detectors) for each service you select. By default, all Cisco-provided detectors are activated. If no detector is enabled for a service, the system automatically enables all Cisco-provided detectors for the associated application protocol; if none exist, the system enables the most recently modified user-defined detector for the application protocol.
 
     [bookmark: pgfId-1532181]This feature requires Protection and Control licenses.
 
     [bookmark: pgfId-1532183]Perform Stream Reassembly on Bo[bookmark: marker-1532182]th Ports
 
     [bookmark: pgfId-1532184]Enables stream reassembly based on ports for both the client and server side of the connection. Use this option when you expect that malicious traffic for the same ports may travel in either direction between clients and servers. You can disable this option by not specifying ports.
 
     [bookmark: pgfId-1532186]Perform Stream Reassembly on Bo[bookmark: marker-1532185]th Services
 
     [bookmark: pgfId-1532187]Enables stream reassembly based on services for both the client and server side of the connection. Use this option when you expect that malicious traffic for the same services may travel in either direction between clients and servers.You can disable this option by not specifying services.
 
     [bookmark: pgfId-1532190]At least one detector must be enabled (see Activating and Deactivating Detectors) for each service you select. By default, all Cisco-provided detectors are activated. If no detector is enabled for an associated client application or application protocol, the system automatically enables all Cisco-provided detectors for the application or application protocol; if none exist, the system enables the most recently modified user-defined detector for the application or application protocol.
 
     [bookmark: pgfId-1532204]This feature requires Protection and Control licenses.
 
    
 
     
      [bookmark: pgfId-1532208][bookmark: 92585]Configuring T[bookmark: marker-1532207]CP Stream Preprocessing
 
     [bookmark: pgfId-1557047]License: Protection
 
     [bookmark: pgfId-1532214]You can configure TCP stream preprocessing, including TCP policies. For more information on the TCP stream preprocessor configuration options, see Selecting TCP Policy Options.
 
     [bookmark: pgfId-1532218]To configure the stream preprocessor to track TCP sessions:
 
     [bookmark: pgfId-1533331]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1585899]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1585900]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1549914]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1549918]The Edit Policy page appears.
 
     [bookmark: pgfId-1549920]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1549921]The Settings page appears.
 
     [bookmark: pgfId-1532234]Step 4 You have two choices, depending on whether TCP Stream Configuration under Transport/Network Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532235]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532236]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532238]The TCP Stream Configuration page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532244]Step 5 Optionally, modify Packet Type Performance Boost under Global Settings. See Selecting The TCP Global Option for more information.
 
     [bookmark: pgfId-1532246]Step 6 You have two options:
 
      
       
       	 [bookmark: pgfId-1532250]Add a new target-based policy. Click the add icon (
 
      
 
      [image: ] ) next to 
       Hosts on the left side of the page. The Add Target pop-up window appears. Specify one or more IP addresses in the 
       Host Address  field and click 
       OK . 
     
 
     [bookmark: pgfId-1532251]You can specify a single IP address or address block. You can create a total of 255 target-based policies including the default policy. For information on using IP address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1583799]Note that for a target-based policy to process traffic, the networks you identify must match or be a subset of the networks, zones, and VLANs handled by the network analysis policy where you configure the target-based policy. See Customizing Preprocessing with Network Analysis Policies for more information.
 
     [bookmark: pgfId-1532258]A new entry appears in the list of targets on the left side of the page, highlighted to indicate that it is selected, and the Configuration section updates to reflect the current configuration for the policy you added.
 
      
       
       	 [bookmark: pgfId-1532259]Modify the settings for an existing target-based policy. Click the configured address for a policy you have added under  Hosts on the left side of the page, or click  default .
 
      
 
     
 ) next to the policy you want to remove. 
     
 
     [bookmark: pgfId-1532264]Step 7 Optionally, modify any of the TCP policy options under Configuration.
 
     [bookmark: pgfId-1532265]For specific instructions on modifying settings for stream reassembly based on client services, server services, or both go to step 8; otherwise, go to step 11.
 
     [bookmark: pgfId-1532275]For more information, see Selecting TCP Policy Options and Selecting Stream Reassembly Options.
 
     [bookmark: pgfId-1532280]Step 8 [bookmark: 57174]To modify settings for stream reassembly based on client, server, or both services, click inside the field you want to modify or click Edit next to the field.
 
     [bookmark: pgfId-1532281]The pop-up window for the field you selected appears.
 
     [bookmark: pgfId-1598539]For example, the following graphic shows the Perform Stream Reassembly on Both Services pop-up window.
 
      
       [bookmark: pgfId-1598543]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-1532287]Note that you can enable adaptive profiles to monitor traffic for the stream preprocessor to reassemble based on services discovered on your network. See Working with Servers and Tuning Preprocessing in Passive Deployments for more information.
 
      [bookmark: pgfId-1532294]Step 9 You have two choices:
 
       
        
        	 [bookmark: pgfId-1532295]To add services to monitor, select one or more services from the  Available list on the left, then click the right arrow ( > ) button.
 
        	 [bookmark: pgfId-1532296]To remove a service, select it from the  Enabled list on the right, then click the left arrow ( < ) button.
 
       
 
      
 
      [bookmark: pgfId-1532297]Use Ctrl or Shift while clicking to select multiple service detectors. You can also click and drag to select multiple adjacent service detectors.
 
      [bookmark: pgfId-1532298]Step 10 Click OK to add the selections.
 
      [bookmark: pgfId-1532299]The TCP Stream Configuration page is displayed and the services are updated.
 
      [bookmark: pgfId-1532303]Step 11 [bookmark: 88990]Optionally, expand the Troubleshooting Options and modify either of the TCP stream preprocessing policy settings only if asked to do so by Support. For more information, see Selecting TCP Policy Options.
 
      [bookmark: pgfId-1532310]Step 12 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
      [bookmark: pgfId-1564674]
 
       
       
 
      
 
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532318][bookmark: 46338]Us[bookmark: marker-1532315]ing UD[bookmark: Stream(UDP)]P Stream Preprocessing
 
    [bookmark: pgfId-1557098]License: Protection
 
    [bookmark: pgfId-1532324]UDP stream preprocessing occurs when the rules engine processes packets against a UDP rule that includes the flow keyword (see Applying Rules to a TCP or UDP Client or Server Flow) using any of the following arguments:
 
     
     	 [bookmark: pgfId-1532328] Established 
 
     	 [bookmark: pgfId-1532329] To Client 
 
     	 [bookmark: pgfId-1532330] From Client 
 
     	 [bookmark: pgfId-1532331] To Server 
 
     	 [bookmark: pgfId-1532332] From Server 
 
    
 
    [bookmark: pgfId-1532333]UDP is a connectionless protocol that does not provide a means for two endpoints to establish a communication channel, exchange data, and close the channel. UDP data streams are not typically thought of in terms of sessions. However, the stream preprocessor uses the source and destination IP address fields in the encapsulating IP datagram header and the port fields in the UDP header to determine the direction of flow and identify a session. A session ends when a configurable timer is exceeded, or when either endpoint receives an ICMP message that the other endpoint is unreachable or the requested service is unavailable.
 
    [bookmark: pgfId-1575182]Note that the system does not generate events related to UDP stream preprocessing; however, you can enable related packet decoder rules to detect UDP protocol header anomalies. For information on events generated by the packet decoder, see Understanding Packet Decoding.
 
     
      [bookmark: pgfId-1575194][bookmark: 95928]Confi[bookmark: marker-1575193]guring UDP Stream Preprocessing
 
     [bookmark: pgfId-1557120]License: Protection
 
     [bookmark: pgfId-1532354]You can configure UDP stream preprocessing.
 
     [bookmark: pgfId-1532355]To configure the stream preprocessor to track UDP sessions:
 
     [bookmark: pgfId-1533345]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1585924]Step 1 Select Policies > Access Control to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1585925]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1550601]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1550605]The Edit Policy page appears.
 
     [bookmark: pgfId-1550607]Step 3 Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1550608]The Settings page appears.
 
     [bookmark: pgfId-1532371]Step 4 You have two choices, depending on whether UDP Stream Configuration under Transport/Network Layer Preprocessors is enabled:
 
      
       
       	 [bookmark: pgfId-1532372]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532373]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1550393]The UDP Stream Configuration page appears. A message at the bottom of the page identifies the policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532380]Step 5 Optionally, configure a Time[bookmark: marker-1532379]out value to specify the number of seconds between 1 and 86400 the preprocessor keeps an inactive stream in the state table. If additional datagrams are not seen in the specified time, the preprocessor deletes the stream from the state table.
 
     [bookmark: pgfId-1532382]Step 6 Optionally, select Packet Type Perf[bookmark: marker-1532381]ormance Boost to ignore UDP traffic for all ports and application protocols that are not specified in enabled rules, except when a UDP rule with both the source and destination ports set to any has a flow or flowbits option. This performance improvement could result in missed attacks.
 
     [bookmark: pgfId-1532383]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
      
       [bookmark: pgfId-1532387]
 
      [bookmark: pgfId-1564697]
 
       
       
 
      
 
      
 
      [bookmark: pgfId-1164863]
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 83148]Tuning Preprocessing in Passive Deployments 
      
      
 
     
 
 
    [bookmark: pgfId-1536717]Typically, the system uses the static settings in your network analysis policy to preprocess and analyze traffic. With the adaptive profiles feature, however, the system can adapt to network traffic by associating traffic with host information from the network map and then processing the traffic accordingly.
 
    [bookmark: pgfId-1530800]When a host receives traffic, the operating system running on the host reassembles IP fragments. The order used for that reassembly depends on the operating system. Similarly, each operating system may implement TCP in different ways, and therefore reassemble TCP streams differently. If preprocessors reassemble data using a format other than that used for the operating system of the destination host, the system may miss content that could be malicious when reassembled on the receiving host.
 
     
      
    
 
    
 
    [bookmark: pgfId-1530804]Tip In a passive deployment, Cisco recommends that you configure adaptive profiles. In an inline deployment, Cisco recommends that you configure the inline normalization preprocessor with the Normalize TCP Payload option enabled. For more information, see Normalizing Inline Traffic.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1530814]For more information on using adaptive profiles to improve reassembly of packet fragments and TCP streams, see the following topics:
 
     
     	 [bookmark: pgfId-1530818]Understanding Adaptive Profiles
 
     	 [bookmark: pgfId-1530822]Configuring Adaptive Profiles
 
    
 
   
 
    
     [bookmark: pgfId-1537095][bookmark: 45020]Understanding Adapti[bookmark: marker-1537094]ve Profiles
 
    [bookmark: pgfId-1537105]License: Protection
 
    [bookmark: pgfId-1537106]Adaptive profiles enable use of the most appropriate operating system profiles for IP defragmentation and TCP stream preprocessing. For more information on the aspects of the network analysis policy affected by adaptive profiles, see Defragmenting IP Packets and Using TCP Stream Preprocessing.
 
    [bookmark: pgfId-1530840]The system can use host information detected by network discovery, obtained through an Nmap scan, or added through the host input feature to adapt processing behavior. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1530841]Note When you input host information from a third-party application using the command line import utility or the host input API, you must first map the data to product definitions so the system can use it for adaptive profiles. For more information, see Managing Third-Party Product Mappings.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1537133]Using Adaptive Profiles with Prepr[bookmark: marker-1537132]ocessors
 
     [bookmark: pgfId-1537789]License: Protection
 
     [bookmark: pgfId-1537144]Adaptive profiles, like the target-based profiles you can configure in a network analysis policy, help to defragment IP packets and reassemble streams in the same way as the operating system on the target host. The intrusion rules engine then analyzes the data in the same format as that used by the destination host.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1534533]For example, you configure adaptive profiles for the 10.6.0.0/16 subnet and set the default IP Defragmentation target-based policy to Linux. The Defense Center where you configure the settings has a network map that includes the 10.6.0.0/16 subnet.
 
     [bookmark: pgfId-1530868]When a device detects traffic from Host A, which is not in the 10.6.0.0/16 subnet, it uses the Linux target-based policy to reassemble IP fragments. However, when it detects traffic from Host B, which is in the 10.6.0.0/16 subnet, it retrieves Host B’s operating system data from the network map, where Host B is listed as running Microsoft Windows XP Professional. The system uses the Windows target-based profile to do the IP defragmentation for the traffic destined for Host B.
 
     [bookmark: pgfId-1530872]See Defragmenting IP Packets for information on the IP Defragmentation preprocessor. See Using TCP Stream Preprocessing for information on the stream preprocessor.
 
    
 
     
      [bookmark: pgfId-1530881][bookmark: 43319]Adaptive Profiles and FireSIGHT [bookmark: marker-1530880]Recommended Rules
 
     [bookmark: pgfId-1537823]License: Protection
 
     [bookmark: pgfId-1537312]The adaptive profiles feature is an advanced setting in an access control policy that applies globally to all intrusion policies invoked by that access control policy. The FireSIGHT recommended rules feature applies to the individual intrusion policy where you configure it.
 
     [bookmark: pgfId-1537342]Like FireSIGHT recommended rules, adaptive profiles compare metadata in a rule to host information to determine whether a rule should apply for a particular host. However, while FireSIGHT recommended rules provide recommendations for enabling or disabling rules using that information, adaptive profiles use the information to apply specific rules to specific traffic. 
 
     [bookmark: pgfId-1538351]FireSIGHT recommended rules require your interaction to implement suggested changes to rule states. Adaptive profiles, on the other hand, do not modify intrusion policies. Adaptive treatment of rules happens on a packet-by-packet basis. 
 
     [bookmark: pgfId-1538355]Additionally, FireSIGHT recommended rules can result in enabling disabled rules. Adaptive profiles, in contrast, only affect the application of rules that are already enabled in intrusion policies. Adaptive profiles never change the rule state.
 
     [bookmark: pgfId-1530907]You can use adaptive profiles and FireSIGHT recommended rules in combination. Adaptive profiles use the rule state for a rule when your intrusion policy is applied to determine whether to include it as a candidate for applying, and your choices to accept or decline recommendations are reflected in that rule state. You can use both features to ensure that you have enabled or disabled the most appropriate rules for each network you monitor, and then to apply enabled rules most efficiently for specific traffic.
 
     [bookmark: pgfId-1530911]See Tailoring Intrusion Protection to Your Network Assets for more information.
 
    
 
   
 
    
     [bookmark: pgfId-1530914][bookmark: 17680]Configuring Adaptive Profi[bookmark: marker-1530913]les
 
    [bookmark: pgfId-1537857]License: Protection
 
    [bookmark: pgfId-1530922]To use host information to determine which target-based profiles are used for IP defragmentation and TCP stream preprocessing, you can configure adaptive profiles. 
 
    [bookmark: pgfId-1538207]When you configure adaptive profiles, you need to bind the adaptive profile setting to a specific network or networks. To successfully use adaptive profiles, that network must exist in the network map and must be in the segment monitored by the devices where you apply the access control policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-1541119]Note To use adaptive profiles, you must enable host discovery in the network discovery policy for the networks you want to protect, then reapply the network discovery policy. For more information, see Creating a Network Discovery Policy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1530925]You can indicate the hosts in the network map where adaptive profiles should be used to process traffic by specifying an IP address, a block of addresses, or a network variable with the desired value configured in the variable set linked to the default intrusion policy for your access control policy. See Setting the Default Intrusion Policy for Access Control for more information.
 
    [bookmark: pgfId-1530926]You can use any of these addressing methods alone or in any combination as a list of IP addresses, address blocks, or variables separated by commas, as shown in the following example: 
 
     
     [bookmark: pgfId-1530927]192.168.1.101, 192.168.4.0/24, $HOME_NET 
    
 
    [bookmark: pgfId-1530933]For information on specifying address blocks in the FireSIGHT System, see IP Address Conventions.
 
     
      
    
 
    
 
    [bookmark: pgfId-1530935]Tip You can apply adaptive profiles to all hosts in the network map by using a variable with a value of any or by specifying 0.0.0.0/0 as the network value.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1530936]You can also control how frequently network map data is synced from the Defense Center to its managed devices. The system uses the data to determine what profiles should be used when processing traffic.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1542273] 
     Caution Enabling or disabling adaptive profiles restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1542277]To configure adaptive profiles:
 
    [bookmark: pgfId-1530941]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1534994]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1534995]The Access Control Policy page appears.
 ) next to the access control policy you want to edit. 
    
 
    [bookmark: pgfId-1535000]The access control policy editor appears.
 
    [bookmark: pgfId-1535001]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1535002]The access control policy advanced settings page appears.
 . 
    
 
    [bookmark: pgfId-1535007]The Detection Enhancement Settings pop-up window appears.
 
    [bookmark: pgfId-1530955]Step 5 Select Adaptive Profiles - Enabled to enable adaptive profiles.
 
    [bookmark: pgfId-1530963]Step 6 Optionally, in the Adaptive Profiles - Attribute Update Interval field, type the number of minutes that should elapse between synchronization of network map data from the Defense Center to its managed devices. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1530967]Note Increasing the value for this option could improve performance in a large network.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1530968]Step 7 In the Adaptive Profiles - Networks field, type the specific IP address, address block, or variable, or a list that includes any of these addressing methods separated by commas, to identify any host in the network map for which you want to use adaptive profiles.
 
    [bookmark: pgfId-1530972]See Working with Variable Sets for information on configuring variables. See Creating a Network Discovery Policy for information on configuring the network map.
 
    [bookmark: pgfId-1535614]Step 8 Click OK to retain your settings.
 
    [bookmark: pgfId-1535615]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1535616]
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1532735][bookmark: 81006]Getting Started with Intrusion Policies 
      
      
 
     
 
 
    [bookmark: pgfId-1548558]Intrusion policies are defined sets of intrusion detection and prevention configurations that inspect traffic for security violations and, in inline deployments, can block or alter malicious traffic. Intrusion policies are invoked by your access control policy and are the system’s last line of defense before traffic is allowed to its destination.
 
    [bookmark: pgfId-1549515]Cisco delivers several intrusion policies with the FireSIGHT System. By using system-provided policies you can take advantage of the experience of the Cisco Vulnerability Research Team (VRT). For these policies, the VRT sets intrusion and preprocessor rule states (enabled or disabled), as well as provides the initial configurations for other advanced settings. An enabled rule causes the system to generate intrusion events for (and optionally block) traffic matching the rule. Disabling a rule stops processing of the rule. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1551339]Tip System-provided intrusion and network analysis policies are similarly named but contain different configurations. For example, the Balanced Security and Connectivity network analysis policy and the Balanced Security and Connectivity intrusion policy work together and can both be updated in intrusion rule updates. However, the network analysis policy governs mostly preprocessing options, whereas the intrusion policy governs mostly intrusion rules. Understanding Network Analysis and Intrusion Policies provides an overview of how network analysis and intrusion policies work together to examine your traffic, as well as some basics on using the navigation panel, resolving conflicts, and committing changes.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1552578]If you create a custom intrusion policy, you can:
 
     
     	 [bookmark: pgfId-1552955]Tune detection by enabling and disabling rules, as well as by writing and adding your own rules.
 
     	 [bookmark: pgfId-1552962]Use FireSIGHT recommendations to associate the operating systems, servers, and client application protocols detected on your network with rules specifically written to protect those assets.
 
     	 [bookmark: pgfId-1552966]Configure various advanced settings such as external alerting, sensitive data preprocessing, and global rule thresholding.
 
     	 [bookmark: pgfId-1552972]Use layers as building blocks to efficiently manage multiple intrusion policies.
 
    
 
    [bookmark: pgfId-1552579]When tailoring your intrusion policy, especially when enabling and adding rules, keep in mind that some intrusion rules require that traffic first be decoded or preprocessed in a certain way. Before an intrusion policy examines a packet, the packet is preprocessed according to configurations in a network analysis policy. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1552688]Note Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1553436]After you configure a custom intrusion policy, you can use it as part of your access control configuration by associating the intrusion policy with one or more access control rules or an access control policy’s default action. This forces the system to use the intrusion policy to examine certain allowed traffic before the traffic passes to its final destination. A variable set that you pair with the intrusion policy allows you to accurately reflect your home and external networks and, as appropriate, the servers on your network. For more information, see Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-1572253]Note that by default, the system disables intrusion inspection of encrypted payloads. This helps reduce false positives and improve performance when an encrypted connection matches an access control rule that has intrusion inspection configured. For more information, see Understanding Traffic Decryption and Using the SSL Preprocessor.
 
    [bookmark: pgfId-1552334]This chapter explains how to create a simple custom intrusion policy. The chapter also contains basic information on managing intrusion policies: editing, comparing, and so on. For more information, see:
 
     
     	 [bookmark: pgfId-1545165]Creating a Custom Intrusion Policy
 
     	 [bookmark: pgfId-1545193]Managing Intrusion Policies
 
     	 [bookmark: pgfId-1545198]Editing Intrusion Policies
 
     	 [bookmark: pgfId-1545203]Applying an Intrusion Policy
 
     	 [bookmark: pgfId-1545213]Generating a Report of Current Intrusion Settings
 
     	 [bookmark: pgfId-1545218]Comparing Two Intrusion Policies or Revisions
 
    
 
   
 
    
     [bookmark: pgfId-1535767][bookmark: 86809]Cre[bookmark: marker-1535815]ating a Custom Intrusion Policy
 
    [bookmark: pgfId-1535774]License: Protection
 
    [bookmark: pgfId-1535596]When you create a new intrusion policy you must give it a unique name, specify a base policy, and specify drop behavior.
 
    [bookmark: pgfId-1535597]The base policy defines the intrusion policy’s default settings. Modifying a setting in the new policy overrides—but does not change—the settings in the base policy. You can use either a system-provided or custom policy as your base policy. For more information, see Understanding the Base Layer.
 
    [bookmark: pgfId-1535598]The intrusion policy’s drop behavior, or Drop when Inline setting, determines how the system handles drop rules (intrusion or preprocessor rules whose rule state is set to Drop and Generate Events) and other intrusion policy configurations that affect traffic. You should enable drop behavior in inline deployments when you want to drop or replace malicious packets. Note that in passive deployments, the system cannot affect traffic flow regardless of the drop behavior. For more information, see Setting Drop Behavior in an Inline Deployment.
 
    [bookmark: pgfId-1535608]To create an intrusion policy:
 
    [bookmark: pgfId-1535612]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1535613]Step 1 Select Policies > Intrusion Policy > Intrusion Policy.
 
    [bookmark: pgfId-1535941]The Intrusion Policy page appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-1535962]Tip You can also import a policy from another Defense Center; see Importing and Exporting Configurations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1535622]Step 2 Click Create Policy.
 
    [bookmark: pgfId-1556327]If you have unsaved changes in another policy, click Cancel when prompted to return to the Intrusion Policy page. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1535623]The Create Intrusion Policy pop-up window appears.
 
    [bookmark: pgfId-1536108]Step 3 Give the policy a unique Name and, optionally, a Description.
 
    [bookmark: pgfId-1536110]Step 4 Specify the initial Base Policy.
 
    [bookmark: pgfId-1536111]You can use either a system-provided or custom policy as your base policy.
 
    [bookmark: pgfId-1535635]Step 5 Set the system’s drop behavior in an inline deployment:
 
     
      
      	 [bookmark: pgfId-1568253]To allow intrusion policies to affect traffic and generate events, enable  Drop when Inline .
 
      	 [bookmark: pgfId-1568254]To prevent intrusion policies from affecting traffic while still generating events, disable  Drop when Inline .
 
     
 
    
 
    [bookmark: pgfId-1535638]Step 6 Create the policy:
 
     
      
      	 [bookmark: pgfId-1535639]Click  Create Policy to create the new policy and return to the Intrusion Policy page. The new policy has the same settings as its base policy.
 
      	 [bookmark: pgfId-1535640]Click  Create and Edit Policy to create the policy and open it for editing in the advanced intrusion policy editor; see Editing Intrusion Policies.
 
     
 
    
 
    [bookmark: pgfId-1535644]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1543349][bookmark: 13111]Managing Intrusion Pol[bookmark: marker-1543348]icies
 
    [bookmark: pgfId-1543353]License: Protection
 
    [bookmark: pgfId-1565637]On the Intrusion Policy page (Policies > Intrusion > Intrusion Policy) you can view your current custom intrusion policies, along with the following information:
 
     
     	 [bookmark: pgfId-1543355]the time and date the policy was last modified (in local time) and the user who modified it
 
     	 [bookmark: pgfId-1543356]whether the  Drop when Inline setting is enabled, which allows you to drop and modify traffic in an inline deployment
 
     	 [bookmark: pgfId-1543357]which access control policies and devices are using the intrusion policy to inspect traffic
 
     	 [bookmark: pgfId-1543358]whether a policy has unsaved changes, as well as information about who (if anyone) is currently editing the policy
 
    
 
    [bookmark: pgfId-1543359]In addition to custom policies that you create, the system provides two custom policies: Initial Inline Policy and Initial Passive Policy. These two intrusion policies use the Balanced Security and Connectivity intrusion policy as their base. The only difference between them is their Drop When Inline setting, which enables drop behavior in the inline policy and disables it in the passive policy. You can edit and use these system-provided custom policies.
 
    [bookmark: pgfId-1543360]Options on the Intrusion Policy page allow you to take the actions in the following table.
 
    [bookmark: pgfId-1543415]
 
     
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1566526]Table 31-1 [bookmark: 22107]Intrusion Policy Management Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1566532]To... 
         
  
        	 
          
          [bookmark: pgfId-1566534]You can... 
         
  
        	 
          
          [bookmark: pgfId-1566536]See... 
         
  
       
 
        
        	[bookmark: pgfId-1566538]create a new intrusion policy
  
        	[bookmark: pgfId-1566540]click Create Policy.
  
        	[bookmark: pgfId-1566544]Creating a Custom Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1566547]edit an existing intrusion policy
  ). 
        	[bookmark: pgfId-1566557]Editing Intrusion Policies
  
       
 
        
        	[bookmark: pgfId-1566559]reapply an intrusion policy to your managed devices
  ). 
        	[bookmark: pgfId-1566568]Applying an Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1566571]export an intrusion policy to import on another Defense Center
  ). 
        	[bookmark: pgfId-1566584]Exporting Configurations
  
       
 
        
        	[bookmark: pgfId-1566586]view a PDF report that lists the current configuration settings in a intrusion policy
  ). 
        	[bookmark: pgfId-1566595]Generating a Report of Current Intrusion Settings
  
       
 
        
        	[bookmark: pgfId-1566598]compare the settings of two intrusion policies or two revisions of the same policy
  
        	[bookmark: pgfId-1566600]click Compare Policies.
  
        	[bookmark: pgfId-1566604]Comparing Two Intrusion Policies or Revisions
  
       
 
        
        	[bookmark: pgfId-1566607]delete an intrusion policy
  
        	 ), then confirm that you want to delete the policy. You cannot delete an intrusion policy if an access control policy references it.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1533742][bookmark: 61093]Editing Intrusion Policies
 
    [bookmark: pgfId-1533381]License: Protection
 
    [bookmark: pgfId-1558315]When you create a new intrusion policy, it has the same intrusion rule and advanced settings as its base policy. The following table explains the most common actions taken when editing an intrusion policy:
 
    [bookmark: pgfId-1569685]
 
     
      
       
       [bookmark: pgfId-1569585]Table 31-2 [bookmark: 35642]Intrusion Policy Editing Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1569591]To... 
         
  
        	 
          
          [bookmark: pgfId-1569593]You can... 
         
  
        	 
          
          [bookmark: pgfId-1569595]See... 
         
  
       
 
        
        	[bookmark: pgfId-1569597]specify drop behavior in an inline deployment
  
        	[bookmark: pgfId-1569599]select or clear the Drop when Inline check box on the Policy Information page.
  
        	[bookmark: pgfId-1569603]Setting Drop Behavior in an Inline Deployment
  
       
 
        
        	[bookmark: pgfId-1569606]change the base policy
  
        	[bookmark: pgfId-1569608]select a base policy from the Base Policy drop-down list on the Policy Information page.
  
        	[bookmark: pgfId-1569612]Changing the Base Policy
  
       
 
        
        	[bookmark: pgfId-1569615]view the settings in the base policy
  
        	[bookmark: pgfId-1569617]click Manage Base Policy on the Policy Information page
  
        	[bookmark: pgfId-1569621]Understanding the Base Layer
  
       
 
        
        	[bookmark: pgfId-1569624]display or configure intrusion rules
  
        	[bookmark: pgfId-1569626]click Manage Rules on the Policy Information page.
  
        	[bookmark: pgfId-1569630]Viewing Rules in an Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1569633]display a filtered view of intrusion rules by current rule state and, optionally, configure those rules
  
        	[bookmark: pgfId-1569635]on the Policy Information page, click View next to the number of rules under Manage Rules that are set to Generate Events or to Drop and Generate Events. 
  
        	[bookmark: pgfId-1569639]Filtering Rules in an Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1569645]configure FireSIGHT recommended rules
  
        	[bookmark: pgfId-1569650]click FireSIGHT Recommendations in the navigation panel
  
        	[bookmark: pgfId-1569654]Using FireSIGHT Recommendations
  
       
 
        
        	[bookmark: pgfId-1569657]display a filtered view of intrusion rules by current recommended rule state and, optionally, configure those rules
  
        	[bookmark: pgfId-1569659]on the Policy Information page, after you generate recommendations:
 
          
          	 [bookmark: pgfId-1569660]click  View next to the number of recommendations to generate events, drop and generate events, or disable rules
 
          	 [bookmark: pgfId-1569661]click  View Recommended Changes to view all recommendations
 
         
  
        	[bookmark: pgfId-1569665]Using FireSIGHT Recommendations
  
       
 
        
        	[bookmark: pgfId-1569668]enable, disable, or edit advanced settings
  
        	[bookmark: pgfId-1569670]click Advanced Settings in the navigation panel
  
        	[bookmark: pgfId-1569674]Configuring Advanced Settings in an Intrusion Policy
  
       
 
        
        	[bookmark: pgfId-1569677]manage policy layers
  
        	[bookmark: pgfId-1569679]click Policy Layers in the navigation panel
  
        	[bookmark: pgfId-1569683]Using Layers in a Network Analysis or Intrusion Policy
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1569686]When tailoring an intrusion policy, especially when enabling and adding rules, keep in mind that some intrusion rules require that traffic first be decoded or preprocessed in a certain way. Before an intrusion policy examines a packet, the packet is preprocessed according to configurations in a network analysis policy. If you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-1569687]Note Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1569691]The system caches one intrusion policy per user. While editing an intrusion policy, if you select any menu or other path to another page, your changes stay in the system cache even if you leave the page. In addition to the actions you can perform in the table above, Understanding Network Analysis and Intrusion Policies provides information on using the navigation panel, resolving conflicts, and committing changes
 
    [bookmark: pgfId-1535300]To edit a intrusion policy:
 
    [bookmark: pgfId-1535304]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1535305]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1535306]The Intrusion Policy page appears.
 ) next to the intrusion policy you want to configure. 
    
 
    [bookmark: pgfId-1566298]The intrusion policy editor appears, focused on the Policy Information page and with a navigation panel on the left.
 
    [bookmark: pgfId-1535312]Step 3 Edit your policy. Take any of the actions summarized above. 
 
    [bookmark: pgfId-1535313]Step 4 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
    [bookmark: pgfId-1535317]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1545758][bookmark: 39489]Setting Drop Behavior in an Inline Deployment
 
     [bookmark: pgfId-1545765]License: Protection
 
     [bookmark: pgfId-1558904]In an inline deployment, an intrusion policy can block and modify traffic:
 
      
      	 [bookmark: pgfId-1559169] Drop rules can drop matching packets and generate intrusion events. To configure an intrusion or preprocessor drop rule, set its state to Drop and Generate Events; see Setting Rule States.
 
      	 [bookmark: pgfId-1559204]Intrusion rules can use the  replace keyword to replace malicious content; see Replacing Content in Inline Deployments.
 
     
 
     [bookmark: pgfId-1559040]For an intrusion rules to affect traffic, you must correctly configure drop rules and rules that replace content, as well as well as correctly deploy managed devices inline, that is, with inline interface sets. Finally, you must enable the intrusion policy’s drop behavior, or Drop when Inline setting.
 
      
       
     
 
     
 
     [bookmark: pgfId-1560238]Note To block the transfer of malware files over FTP, you must not only correctly configure network-based advanced malware protection (AMP), but also enable Drop when Inline in your access control policy’s default intrusion policy. To determine or change the default intrusion policy, see Setting the Default Intrusion Policy for Access Control.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1560472]If you want to assess how your configuration would function in an inline deployment without actually affecting traffic, you can disable drop behavior. In this case, the system generates intrusion events but does not drop packets that trigger drop rules. When you are satisfied with the results, you can enable drop behavior. 
 
     [bookmark: pgfId-1560679]Note that in passive deployments or inline deployments in tap mode, the system cannot affect traffic regardless of the drop behavior. In other words, in a passive deployment, rules set to Drop and Generate Events behave identically to rules set to Generate Events—the system generates intrusion events but cannot drop packets.
 
     [bookmark: pgfId-1545779]When you view intrusion events, workflows can include the inline result, which indicates whether traffic was actually dropped, or whether it only would have dropped. When a packet matches a drop rule, the inline result is:
 
      
      	 [bookmark: pgfId-1558534] Dropped  ,  for packets dropped by a correctly configured inline deployment with drop behavior enabled
 
      	 [bookmark: pgfId-1558707] Would have dropped , for packets that were not dropped either because your devices are deployed passively or because drop behavior is disabled. Note that the inline result is always  Would have dropped for packets seen while the system is pruning, regardless of deployment.
 
     
 
     [bookmark: pgfId-1556702]To set the drop behavior of an intrusion policy in an inline deployment:
 
     [bookmark: pgfId-1545859]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1545860]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1545861]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1545870]The Policy Information page appears.
 
     [bookmark: pgfId-1545871]Step 3 Set the policy’s drop behavior:
 
      
       
       	 [bookmark: pgfId-1561482]To allow intrusion rules to affect traffic and generate events, enable  Drop when Inline .
 
       	 [bookmark: pgfId-1561483]To prevent intrusion rules from affecting traffic while still generating events, disable  Drop when Inline .
 
      
 
     
 
     [bookmark: pgfId-1557415]Step 4 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. For more information, see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1561573]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1535372][bookmark: 13049]Configuring Advanced Settings in an Intrusion Pol[bookmark: marker-1539264][bookmark: marker-1539265]icy
 
     [bookmark: pgfId-1537779]License: Protection
 
     [bookmark: pgfId-1537872]An intrusion policy’s advanced settings require specific expertise to configure. The base policy for your intrusion policy determines which advanced settings are enabled by default and the default configuration for each.
 
     [bookmark: pgfId-1536718]When you select Advanced Settings in the navigation panel of an intrusion policy, the policy lists its advanced settings by type. On the Advanced Settings page, you can enable or disable advanced settings in your intrusion policy, as well as access advanced setting configuration pages.
 
     [bookmark: pgfId-1539124]An advanced setting must be enabled for you to configure it. When you enable an advanced setting, a sublink to the configuration page for the advanced setting appears beneath the Advanced Settings link in the navigation panel, and an Edit link to the configuration page appears next to the advanced setting on the Advanced Settings page. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1561862]Tip To revert an advanced setting’s configuration to the settings in the base policy, click Revert to Defaults on the configuration page for the advanced setting. When prompted, confirm that you want to revert.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1563741]When you disable an advanced setting, the sublink and Edit link no longer appear, but your configurations are retained. Note that some intrusion policy configurations (sensitive data rules, SNMP alerts for intrusion rules) require enabled and correctly configured advanced settings. You cannot save an intrusion policy misconfigured in this way; see Resolving Conflicts and Committing Policy Changes.
 
     [bookmark: pgfId-1536724]Modifying the configuration of an advanced setting requires an understanding of the configuration you are modifying and its potential impact on your network. The following sections provide links to specific configuration details for each advanced setting.
 
     [bookmark: pgfId-1537999]Specific Threat Detection
 
     [bookmark: pgfId-1538030]The sensitive data preprocessor detects sensitive data such as credit card numbers and Social Security numbers in ASCII text. For information on configuring this preprocessor, see Detecting Sensitive Data.
 
     [bookmark: pgfId-1538057]Note that other preprocessors that detect specific threats (back orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic) are configured in network analysis policies. For more information, see Detecting Specific Threats.
 
     [bookmark: pgfId-1538413]Intrusion Rule Thresholds
 
     [bookmark: pgfId-1538414]Global rule thresholding can prevent your system from being overwhelmed with a large number of events by allowing you to use thresholds to limit the number of times the system logs and displays intrusion events. For more information, see Globally Limiting Intrusion Event Logging.
 
     [bookmark: pgfId-1535215]External Responses
 
     [bookmark: pgfId-1538495]In addition to the various views of intrusion events within the web interface, you can enable logging to system log (syslog) facilities or send event data to an SNMP trap server. Per policy, you can specify intrusion event notification limits, set up intrusion event notification to external logging facilities, and configure external responses to intrusion events. For more information, see:
 
      
      	 [bookmark: pgfId-1569103]Configuring SNMP Responses
 
      	 [bookmark: pgfId-1569132]Configuring Syslog Responses
 
     
 
     [bookmark: pgfId-1538653]Note that in addition to these per-policy alerting configurations, you can globally enable or disable email alerting on intrusion events for each rule or rule group. Your email alert settings are used regardless of which intrusion policy processes a packet. For more information, see Understanding Email Alerting.
 
    
 
   
 
    
     [bookmark: pgfId-1532783][bookmark: 29037]Applying an Intrusion Policy
 
    [bookmark: pgfId-1532790]License: Protection
 
    [bookmark: pgfId-1535048]After you apply an intrusion policy to a managed device using access control (see Applying an Access Control Policy), you can reapply the intrusion policy at any time. This allows you to implement intrusion policy changes on your monitored network without reapplying the access control policy. While reapplying, you can also view a comparison report to review the changes made since the last time the intrusion policy was applied.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1576534] 
     Caution When you reapply an intrusion policy, resource demands may result in a small number of packets dropping without inspection. Additionally, reapplying an intrusion policy after importing an intrusion rule update that includes a new or updated shared object rule restarts the Snort process, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     Configurations that Restart the Snort Process and 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1535050]Note the following when reapplying intrusion policies:
 
     
     	 [bookmark: pgfId-1535053]You can schedule intrusion policy reapply tasks to recur on a regular basis; see Automating Applying an Intrusion Policy.
 
     	 [bookmark: pgfId-1535055]An intrusion policy reapply fails on invalid target devices. For example, if you apply an access control policy that removes a previously applied intrusion policy from a device and then attempt to reapply the intrusion policy before the access control policy apply task resolves, the intrusion policy reapply fails. 
 
     	 [bookmark: pgfId-1535058]You cannot apply intrusion policies to stacked devices running different versions of the FireSIGHT System (for example, if an upgrade on one of the devices fails). You can reapply an intrusion policy to a device stack, but not to individual devices within the stack.
 
     	 [bookmark: pgfId-1535063]When you import a rule update, you can automatically apply intrusion policies after the import completes. If you do not enable this option, you must manually reapply the policies changed by the rule update. See Importing Rule Updates and Local Rule Files for more information.
 
     	 [bookmark: pgfId-1535070]If the Snort version on the Defense Center differs from that on the managed device, you cannot apply an intrusion policy to the device without applying the access control policy. If intrusion policy apply fails for this reason, reapply the entire access control policy instead.
 
     	 [bookmark: pgfId-1573778]On devices with limited memory, the number of intrusion policies may not be paired with more than one variable set. in the case where you can apply an access control policy that references only one intrusion policy, verify every reference to the intrusion policy is paired with the same variable set.
 
    
 
    [bookmark: pgfId-1535071]To reapply an intrusion policy:
 
    [bookmark: pgfId-1535075]Access: Admin/Security Approver
 
    
 
    [bookmark: pgfId-1535076]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1535077]The Intrusion Policy page appears. 
 ) next to the policy you want to reapply. 
    
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1535190]Step 4 Click Reapply.
 
   [bookmark: pgfId-1535093]The policy is reapplied. You can monitor the status of the apply using the task queue (System > Monitoring > Task Status). See Viewing the Task Queue for more information.
 
   [bookmark: pgfId-1535116]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1532792][bookmark: 37768]Generating a Report of Current Intru[bookmark: marker-1534616]sion Settings
 
    [bookmark: pgfId-1532799]License: Protection
 
    [bookmark: pgfId-1534218]An intrusion policy report is a record of the policy configuration at a specific point in time. The system combines the settings in the base policy with the settings of the policy layers, and makes no distinction between which settings originated in the base policy or policy layer.
 
     
      
       
       [bookmark: pgfId-1534280]Table 31-3 [bookmark: 90226]Intrusion Policy Report Sections 
 
       
       
        
        	 
          
          [bookmark: pgfId-1534284]Section 
         
  
        	 
          
          [bookmark: pgfId-1534286]Description 
         
  
       
 
        
        	[bookmark: pgfId-1534297]Policy Information
  
        	[bookmark: pgfId-1534344]Provides the name and description of the intrusion policy, the name of the user who last modified the policy, and the date and time the policy was last modified. Also indicates whether dropping packets in an inline deployment is enabled or disabled, the current rule update version, and whether the base policy is locked to the current rule update.
  
       
 
        
        	[bookmark: pgfId-1534307]FireSIGHT Recommendations
  
        	[bookmark: pgfId-1534309]Provides information on any recommended rule states based on the hosts and applications in your network. Optionally, it includes differences between recommendations and rule states in policy reports if you enabled that setting when you configured FireSIGHT recommendations
  
       
 
        
        	[bookmark: pgfId-1534314]Advanced Settings
  
        	[bookmark: pgfId-1534316]Lists all enabled intrusion policy advanced settings and their configurations.
  
       
 
        
        	[bookmark: pgfId-1534321]Rules
  
        	[bookmark: pgfId-1534323]Provides a list of all enabled rules and their actions.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1534242]You can also generate a comparison report that compares two intrusion policies, or two revisions of the same policy. For more information, see Comparing Two Intrusion Policies or Revisions.
 
    [bookmark: pgfId-1534132]To view an intrusion policy report:
 
    [bookmark: pgfId-1534136]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1534137]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1534138]The Intrusion Policy page appears.
 ) next to the intrusion policy for which you want to generate a report. Remember to commit any potential changes before you generate an intrusion policy report; only committed changes appear in the report. 
    
 
    [bookmark: pgfId-1534143]The system generates the intrusion policy report. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
    [bookmark: pgfId-1534144]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1532802][bookmark: 22780]Comparing Two Intrusion Policies or Revi[bookmark: marker-1534629]sions
 
    [bookmark: pgfId-1532809]License: Protection
 
    [bookmark: pgfId-1534670]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between two intrusion policies. You can compare any two intrusion policies or two revisions of the same intrusion policy, for the intrusion policies you can access. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies or policy revisions.
 
    [bookmark: pgfId-1534671]There are two tools you can use to compare intrusion policies or intrusion policy revisions:
 
     
     	 [bookmark: pgfId-1534672]The comparison view displays only the differences between two intrusion policies or intrusion policy revisions in a side-by-side format; the name of each policy or policy revision appears in the title bar on the left and right sides of the comparison view.
 
    
 
    [bookmark: pgfId-1534673]You can use this to view and navigate both policy revisions on the web interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-1534674]The comparison report creates a record of only the differences between two intrusion policies or intrusion policy revisions in a format similar to the intrusion policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-1534675]You can use this to save, copy, print and share your policy comparisons for further examination.
 
    [bookmark: pgfId-1534676]For more information on understanding and using the intrusion policy comparison tools, see:
 
     
     	 [bookmark: pgfId-1534680]Using the Intrusion Policy Comparison View
 
     	 [bookmark: pgfId-1534684]Using the Intrusion Policy Comparison Report
 
    
 
     
      [bookmark: pgfId-1534687][bookmark: 23989]Using the Intrusion Polic[bookmark: marker-1534686]y Comparison View
 
     [bookmark: pgfId-1534694]License: Protection
 
     [bookmark: pgfId-1534695]The comparison view displays both intrusion policies or policy revisions in a side-by-side format, with each policy or policy revision identified by name in the title bar on the left and right sides of the comparison view. The time of last modification and the last user to modify are displayed to the right of the policy name. Note that the Intrusion Policy page displays the time a policy was last modified in local time, but the intrusion policy report lists the time modified in UTC. Differences between the two intrusion policies or policy revisions are highlighted:
 
      
      	 [bookmark: pgfId-1534696]Blue indicates that the highlighted setting is different in the two policies or policy revisions, and the difference is noted in red text. 
 
      	 [bookmark: pgfId-1534697]Green indicates that the highlighted setting appears in one policy or policy revision but not the other.
 
     
 
      
      
 
      [bookmark: pgfId-1534727]The window displays the name of the layer that contains the advanced configuration.
 
       
        
        [bookmark: pgfId-1534705]Table 31-4 [bookmark: 91381]Intrusion Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534709]To... 
          
  
         	 
           
           [bookmark: pgfId-1534711]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1534713]navigate individually through changes
  
         	[bookmark: pgfId-1534715]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-1534721]determine which layer contains the configuration for a specific advanced setting
  ) next to the configuration you want to view. 
        
 
         
         	[bookmark: pgfId-1534732]generate a new intrusion policy comparison view
  
         	[bookmark: pgfId-1534734]click New Comparison.
 [bookmark: pgfId-1534737]The Select Comparison window appears. See Using the Intrusion Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-1534740]generate an intrusion policy comparison report
  
         	[bookmark: pgfId-1534742]click Comparison Report. 
 [bookmark: pgfId-1534743]The policy comparison report creates a PDF that lists only the differences between the two policies or policy revisions.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1534748][bookmark: 17664]Using the Intrusion Policy C[bookmark: marker-1534747]omparison Report
 
     [bookmark: pgfId-1534755]License: Protection
 
     [bookmark: pgfId-1534756]An intrusion policy comparison report is a record of all differences between two intrusion policies or two revisions of the same intrusion policy identified by the intrusion policy comparison view, presented as a PDF. You can use this report to further examine the differences between two intrusion policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-1534757]You can generate an intrusion policy comparison report from the comparison view for any intrusion policies to which you have access. Remember to commit any potential changes before you generate an intrusion policy report; only committed changes appear in the report.
 
     [bookmark: pgfId-1534758]The format of the intrusion policy comparison report is the same as the intrusion policy report with one exception: the intrusion policy report contains all settings in the intrusion policy, and the intrusion policy comparison report lists only those settings which differ between the policies.
 
     [bookmark: pgfId-1534759]Depending on your configuration, an intrusion policy comparison report can contain one or more sections as described in the Intrusion Policy Report Sections table.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534913]Tip You can use a similar procedure to compare SSL, access control, network analysis, file, system, or health policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534776]To compare two intrusion policies or two revisions of the same policy:
 
     [bookmark: pgfId-1534780]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1534781]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1534782]The Intrusion Policy page appears.
 
     [bookmark: pgfId-1534783]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-1534784]The Select Comparison window appears.
 
     [bookmark: pgfId-1534785]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
      
       
       	 [bookmark: pgfId-1534786]To compare two different policies, select  Other Policy .
 
       	 [bookmark: pgfId-1534787]To compare two revisions of the same policy, select  Other Revision .
 
      
 
     
 
     [bookmark: pgfId-1534788]Remember to commit any changes before you generate an intrusion policy report; only committed changes appear in the report.
 
     [bookmark: pgfId-1534789]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-1534790]If you are comparing two different policies, select the policies you want to compare from the  Policy A  and  Policy B  drop-down lists.
 
       	 [bookmark: pgfId-1534791]If you are comparing two revisions of the same policy, select the policy from the  Policy drop-down list, then select the revisions you want to compare from the  Revision A  and  Revision B  drop-down lists.
 
      
 
     
 
     [bookmark: pgfId-1534792]Step 5 Click OK to display the intrusion policy comparison view.
 
     [bookmark: pgfId-1534793]The comparison view appears.
 
     [bookmark: pgfId-1534794]Step 6 Click Comparison Report to generate the intrusion policy comparison report. 
 
     [bookmark: pgfId-1534795]Step 7 The intrusion policy report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
     [bookmark: pgfId-1534796]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1531775][bookmark: 28486]Tuning Intrusion Policies Using Ru[bookmark: marker-1557611][bookmark: marker-1557612]les 
      
      
 
     
 
 
    [bookmark: pgfId-1533610]You can use the Rules page in an intrusion policy to configure rule states and other settings for shared object rules, standard text rules, and preprocessor rules.
 
    [bookmark: pgfId-1533615]You enable a rule by setting its rule state to Generate Events or to Drop and Generate Events. Enabling a rule causes the system to generate events on traffic matching the rule. Disabling a rule stops processing of the rule. Optionally, you can set your intrusion policy so that a rule set to Drop and Generate Events in an inline deployment generates events on, and drops, matching traffic. See Setting Drop Behavior in an Inline Deployment for more information. In a passive deployment, a rule set to Drop and Generate Events just generates events on matching traffic.
 
    [bookmark: pgfId-1533620]You can filter rules to display a subset of rules, enabling you to select the exact set of rules where you want to change rule states or rule settings.
 
    [bookmark: pgfId-1568255]When an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s web interface. For more information, see Limitations of Custom Policies.
 
    [bookmark: pgfId-1533622]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1533626]Understanding Intrusion Prevention Rule Types describes the intrusion rules and preprocessor rules you can view and configure in an intrusion policy.
 
     	 [bookmark: pgfId-1533630]Viewing Rules in an Intrusion Policy describes how you can change the order of rules on the Rules page, interpret the icons on the page, and focus in on rule details.
 
     	 [bookmark: pgfId-1533634]Filtering Rules in an Intrusion Policy describes how you can use rule filters to find the rules for which you want to apply rule settings.
 
     	 [bookmark: pgfId-1533638]Setting Rule States describes how to enable and disable rules from the Rules page.
 
     	 [bookmark: pgfId-1533642]Filtering Intrusion Event Notification Per Policy explains how to set event filtering thresholds for specific rules and set suppression on specific rules.
 
     	 [bookmark: pgfId-1533646]Adding Dynamic Rule States explains how to set rule states that trigger dynamically when rate anomalies are detected in matching traffic. 
 
     	 [bookmark: pgfId-1533650]Adding SNMP Alerts describes how to associate SNMP alerts with specific rules.
 
     	 [bookmark: pgfId-1533583]Adding Rule Comments describes how to add comments to rules in an intrusion policy.
 
    
 
   
 
    
     [bookmark: pgfId-1532200][bookmark: 72332]Understanding Intrusion Prevention Rule Types
 
    [bookmark: pgfId-1533841]License: Protection
 
    [bookmark: pgfId-1533842]An intrusion policy contains two types of rules: intrusion rules and preprocessor rules.
 
    [bookmark: pgfId-1533843]An intrusion rule is a specified set of keywords and arguments that detects attempts to exploit vulnerabilities on your network; an intrusion rule analyzes network traffic to check if it matches the criteria in the rule. The system compares packets against the conditions specified in each rule and, if the packet data matches all the conditions specified in a rule, the rule triggers. The system includes two types of intrusion rules created by the Cisco Vulnerability Research Team (VRT): shared object rules, which are compiled and cannot be modified (except for rule header information such as source and destination ports and IP addresses), and standard text rules, which can be saved and modified as new custom instances of the rule.
 
    [bookmark: pgfId-1533853]The system also includes preprocessor rules, which are rules associated with preprocessor and packet decoder detection options. You cannot copy or edit preprocessor rules. Most preprocessor rules are disabled by default and must be enabled (that is, set to Generate Events or to Drop and Generate Events) if you want the system to generate events for preprocessor rules and, in an inline deployment, drop offending packets.
 
    [bookmark: pgfId-1534580]The VRT determines the default rule states of Cisco’s shared object rules, standard text rules, and preprocessor rules for each default intrusion policy included with the system.
 
     
      
       
       [bookmark: pgfId-1535114]Table 32-1 [bookmark: 45846]Rule types
 
       
       
        
        	 
          
          [bookmark: pgfId-1535118]Type 
         
  
        	 
          
          [bookmark: pgfId-1535120]Description 
         
  
       
 
        
        	[bookmark: pgfId-1535227][bookmark: marker-1535223]shared object rule
  
        	[bookmark: pgfId-1535124]An intrusion rule created by the Cisco Vulnerability Research Team (VRT) that is delivered as a binary module compiled from C source code. You can use shared object rules to detect attacks in ways that standard text rules cannot. You cannot modify the rule keywords and arguments in a shared object rule; you are limited to either modifying variables used in the rule, or modifying aspects such as the source and destination ports and IP addresses and saving a new instance of the rule as a custom shared object rule. A shared object rule has a GID (generator ID) of 3. See Modifying Existing Rules for more information.
  
       
 
        
        	[bookmark: pgfId-1535201][bookmark: marker-1535197]standard text rule
  
        	[bookmark: pgfId-1535128]An intrusion rule either created by the VRT, copied and saved as a new custom rule, created using the rule editor, or imported as a local rule that you create on a local machine and import. You cannot modify the rule keywords and arguments in a standard rule created by the VRT; you are limited to either modifying variables used in the rule, or modifying aspects such as the source and destination ports and IP addresses and saving a new instance of the rule as a custom standard text rule. See Modifying Existing Rules, Understanding and Writing Intrusion Rules and Importing Local Rule Files for more information. A standard text rule created by the VRT has a GID (generator ID) of 1. Custom standard text rules that you create using the rule editor or import as local rules have a SID (Signature ID) of 1000000 or greater.
  
       
 
        
        	[bookmark: pgfId-1535250]pre[bookmark: marker-1535249]processor rule
  
        	[bookmark: pgfId-1535450]A rule associated with a detection option of the packet decoder or with one of the preprocessors included with the FireSIGHT System. You must enable preprocessor rules if you want them to generate events. These rules have a decoder- or preprocessor-specific GID (generator ID). See the Generator IDs table for more information.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1548592][bookmark: 93476]Viewing Rules in an Intrusion Po[bookmark: marker-1548591]licy
 
    [bookmark: pgfId-1535550]License: Protection
 
    [bookmark: pgfId-1535551]You can adjust how rules are displayed in the intrusion policy, and can sort rules by several criteria. You can also display the details for a specific rule to see rule settings, rule documentation, and other rule specifics. 
 
    [bookmark: pgfId-1535552]The Rules page has four primary areas of functionality: 
 
     
     	 [bookmark: pgfId-1535556]the filtering features—for more information, see Filtering Rules in an Intrusion Policy
 
     	 [bookmark: pgfId-1535562]the rule attribute menus—for more information, see Setting Rule States, Filtering Intrusion Event Notification Per Policy, Adding Dynamic Rule States, Adding SNMP Alerts, and Adding Rule Comments
 
     	 [bookmark: pgfId-1535576]the rules listing—for more information, see the  Rules Page Columns  table.
 
     	 [bookmark: pgfId-1535580]the rule details—for more information, see Viewing Rule Details
 
    
 
    [bookmark: pgfId-1535583]You can also sort rules by different criteria; for more information, see Sorting the Rule Display.
 ) as the Rule State column. 
    
 
     
     
 
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-1536764]Table 32-2 [bookmark: 77863]Rules Page Columns
 
       
       
        
        	 
          
          [bookmark: pgfId-1536770]Heading 
         
  
        	 
          
          [bookmark: pgfId-1536772]Description 
         
  
        	 
          
          [bookmark: pgfId-1536774]For more information, see... 
         
  
       
 
        
        	[bookmark: pgfId-1536776]GID
  
        	[bookmark: pgfId-1536778]Integer which indicates the Generator ID (GID) for the rule.
  
        	[bookmark: pgfId-1536782]Reading Preprocessor Generator IDs
  
       
 
        
        	[bookmark: pgfId-1536785]SID
  
        	[bookmark: pgfId-1536787]Integer which indicates the Snort ID (SID), which acts a unique identifier for the rule.
  
        	[bookmark: pgfId-1536791]Reading Preprocessor Generator IDs
  
       
 
        
        	[bookmark: pgfId-1536794]Message
  
        	[bookmark: pgfId-1536796]Message included in events generated by this rule, which also acts as the name of the rule.
  
        	[bookmark: pgfId-1536800]Defining the Event Message
  
       
 
       
          
        	[bookmark: pgfId-1536808]The rule state for the rule, which may be one of three states:
 
          
          	 [bookmark: pgfId-1536812]drop and generate events (
 
          [image: ] ) 
         
 
          
          	 [bookmark: pgfId-1536816]generate events (
 
          [image: ] ) 
         
 
          
          	 [bookmark: pgfId-1536820]disable (
 
          [image: ] ) 
         
 [bookmark: pgfId-1536822]Note that you can access the Set rule state dialog box for a rule by clicking on its rule state icon.
  
        	[bookmark: pgfId-1536826]Setting Rule States
  
       
 
       
          
        	[bookmark: pgfId-1536837]FireSIGHT recommended rule state for the rule.
  
        	[bookmark: pgfId-1536841]Tailoring Intrusion Protection to Your Network Assets
  
       
 
       
          
        	[bookmark: pgfId-1536849]Event filter, including event thresholds and event suppression, applied to the rule.
  
        	[bookmark: pgfId-1536853]Filtering Intrusion Event Notification Per Policy
  
       
 
       
          
        	[bookmark: pgfId-1536931]Dynamic rule state for the rule, which goes into effect if specified rate anomalies occur.
  
        	[bookmark: pgfId-1536955]Adding Dynamic Rule States
  
       
 
       
          
        	[bookmark: pgfId-1537011]Alerts configured for the rule (currently SNMP alerts only).
  
        	[bookmark: pgfId-1537036]Adding SNMP Alerts
  
       
 
       
          
        	[bookmark: pgfId-1537083]Comments added to the rule.
  
        	[bookmark: pgfId-1537107]Adding Rule Comments
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1537132]You can also use the layer drop-down list to switch to the Rules page for other layers in your policy. Note that, unless you add layers to your policy, the only editable views listed in the drop-down list are the policy Rules page and the Rules page for a policy layer that is originally named My Changes; note also that making changes in one of these views is the same as making the changes in the other. See Using Layers in a Network Analysis or Intrusion Policy for more information. The drop-down list also lists the Rules page for the read-only base policy. See Understanding the Base Layer for information on the base policy.
 
    [bookmark: pgfId-1537177]To view the rules in an intrusion policy:
 
    [bookmark: pgfId-1537181]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1537182]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1537183]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1537188]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1537192]The Policy Information page appears.
 
    [bookmark: pgfId-1537194]Step 3 [bookmark: 81363]Click Rules on the Policy Information page.
 
    [bookmark: pgfId-1537195]The Rules page appears. By default, the page lists the rules alphabetically by message.
 
    [bookmark: pgfId-1537196]Note that selecting Rules above the dividing line in the navigation panel takes you to the same rules listing. You can view and set all rule attributes in your policy in this view.
 
    [bookmark: pgfId-1537197]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1548606][bookmark: 38424]Sorting the [bookmark: marker-1548605]Rule Display
 
     [bookmark: pgfId-1537291]License: Protection
 
     [bookmark: pgfId-1537292]You can sort rules by any of the columns in the Rules page by clicking on the heading title or icon. 
 ) arrow on a heading or icon indicates that the sort is on that column in that direction. 
     
 
     [bookmark: pgfId-1537300]To sort rules in an intrusion policy:
 
     [bookmark: pgfId-1537304]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1537305]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1537306]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1537311]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1537315]The Policy Information page appears.
 
     [bookmark: pgfId-1537317]Step 3 [bookmark: 53178]Click Rules.
 
     [bookmark: pgfId-1537318]The Rules page appears. By default, the page lists the rules alphabetically by message.
 
     [bookmark: pgfId-1537319]Step 4 Click the title or icon in the top of the column you want to sort by.
 
     [bookmark: pgfId-1537320]The rules are sorted by the column, in the direction indicated by the arrow that appears on the column heading. To sort in the opposite direction, click the heading again. The sort order and the arrow reverse.
 
     [bookmark: pgfId-1537321]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537325][bookmark: 18580]Viewing R[bookmark: marker-1537323][bookmark: marker-1537324]ule Details
 
     [bookmark: pgfId-1537332]License: Protection
 
     [bookmark: pgfId-1537336]You can view rule documentation, FireSIGHT recommendations, and rule overhead from the Rule Detail view. You can also view and add rule-specific features.
 
      
       
        
        [bookmark: pgfId-1537343]Table 32-3 Rule Details 
 
        
        
         
         	 
           
           [bookmark: pgfId-1537349]Item 
          
  
         	 
           
           [bookmark: pgfId-1537351]Description 
          
  
         	 
           
           [bookmark: pgfId-1537353]For more information, see... 
          
  
        
 
         
         	[bookmark: pgfId-1537355]Summary
  
         	[bookmark: pgfId-1537357]The rule summary. For rule-based events, this row appears when the rule documentation contains summary information. 
  
         	[bookmark: pgfId-1537362]Viewing Event Information
  
        
 
         
         	[bookmark: pgfId-1537364]Rule State
  
         	[bookmark: pgfId-1537366]The current rule state for the rule. Also indicates the layer where the rule state is set.
  
         	[bookmark: pgfId-1537373]Setting Rule States; Using Layers in a Network Analysis or Intrusion Policy
  
        
 
         
         	[bookmark: pgfId-1537379]FireSIGHT Recommendation
  
         	[bookmark: pgfId-1537384]If FireSIGHT recommendations have been generated, the recommended rule state for the rule.
  
         	[bookmark: pgfId-1537388]Tailoring Intrusion Protection to Your Network Assets
  
        
 
         
         	[bookmark: pgfId-1537391]Rule Overhead
  
         	[bookmark: pgfId-1537393]The rule’s potential impact on system performance and the likelihood that the rule might generate false positives.
  
         	[bookmark: pgfId-1537398]Understanding Rule Overhead
  
        
 
         
         	[bookmark: pgfId-1537400]Thresholds
  
         	[bookmark: pgfId-1537402]Thresholds currently set for this rule, as well as the facility to add a threshold for the rule.
  
         	[bookmark: pgfId-1537407]Setting a Threshold for a Rule
  
        
 
         
         	[bookmark: pgfId-1537409]Suppressions
  
         	[bookmark: pgfId-1537411]Suppression settings currently set for this rule, as well as the facility to add suppressions for the rule.
  
         	[bookmark: pgfId-1537416]Setting Suppression for a Rule
  
        
 
         
         	[bookmark: pgfId-1537418]Dynamic State
  
         	[bookmark: pgfId-1537420]Rate-based rule states currently set for this rule, as well as the facility to add dynamic rule states for the rule.
  
         	[bookmark: pgfId-1537425]Setting a Dynamic Rule State for a Rule
  
        
 
         
         	[bookmark: pgfId-1537427]Alerts
  
         	[bookmark: pgfId-1537429]Alerts currently set for this rule, as well as the facility to add an alert for the rule. Currently, only SNMP alerts are supported.
  
         	[bookmark: pgfId-1537439]Setting an SNMP Alert for a Rule
  
        
 
         
         	[bookmark: pgfId-1537441]Comments
  
         	[bookmark: pgfId-1537443]Comments added to this rule, as well as the facility to add comments for the rule.
  
         	[bookmark: pgfId-1537448]Adding a Rule Comment for a Rule
  
        
 
         
         	[bookmark: pgfId-1537450]Documentation
  
         	[bookmark: pgfId-1537452]The rule documentation for the current rule, supplied by the Cisco Vulnerability Research Team (VRT).
  
         	[bookmark: pgfId-1537460]Using Packet View Actions
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1537462]To view rule details:
 
     [bookmark: pgfId-1537466]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1537467]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1537468]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1537473]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1537477]The Policy Information page appears.
 
     [bookmark: pgfId-1537479]Step 3 [bookmark: 67092]Click Rules.
 
     [bookmark: pgfId-1537480]The Rules page appears. By default, the page lists the rules alphabetically by message.
 
     [bookmark: pgfId-1537481]Step 4 Highlight the rule whose rule details you want to view.
 
     [bookmark: pgfId-1537482]Step 5 Click Show details.
 
     [bookmark: pgfId-1537483]The Rule Detail view appears. To hide the details again, click Hide details.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537484]Tip You can also open Rule Detail by double-clicking a rule in the Rules view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1537485]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537488][bookmark: 25931]Setting a Threshold fo[bookmark: marker-1537487]r a Rule
 
     [bookmark: pgfId-1537495]License: Protection
 
     [bookmark: pgfId-1537496]You can set a single threshold for a rule from the Rule Detail page. Adding a threshold overwrites any existing threshold for the rule. For more information on thresholding, see Configuring Event Thresholding.
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1537504]To set a threshold from the rule details:
 
     [bookmark: pgfId-1537508]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1537509]Step 1 Click Add next to Thresholds.
 
     [bookmark: pgfId-1537510]The Set Threshold dialog box appears.
 
     [bookmark: pgfId-1537511]Step 2 From the Type drop-down list, select the type of threshold you want to set:
 
      
       
       	 [bookmark: pgfId-1537512]Select  Limit to limit notification to the specified number of event instances per time period.
 
       	 [bookmark: pgfId-1537513]Select  Threshold to provide notification for each specified number of event instances per time period.
 
       	 [bookmark: pgfId-1537514]Select  Both to provide notification once per time period after a specified number of event instances.
 
      
 
     
 
     [bookmark: pgfId-1537515]Step 3 From the Track By drop-down list, select Source or Destination to indicate whether you want the event instances tracked by source or destination IP address.
 
     [bookmark: pgfId-1537516]Step 4 In the Count field, type the number of event instances you want to use as your threshold.
 
     [bookmark: pgfId-1537517]Step 5 In the Seconds field, type a number between 0 and 2147483647 that specifies the time period, in seconds, for which event instances are tracked.
 
     [bookmark: pgfId-1537518]Step 6 Click OK.
 ) next to the rule in the Event Filtering column. If you add multiple event filters to a rule, the system includes an indication over the icon of the number of event filters. 
     
 
     [bookmark: pgfId-1537523]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1537526][bookmark: 97473]Setting Suppression f[bookmark: marker-1537525]or a Rule
 
     [bookmark: pgfId-1537533]License: Protection
 
     [bookmark: pgfId-1537534]You can set one or more suppressions for a rule from the Rule Detail page. For more information on suppression, see Configuring Suppression Per Intrusion Policy.
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1537542]To set suppression from the rule details:
 
     [bookmark: pgfId-1537546]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1537547]Step 1 Click Add next to Suppressions.
 
     [bookmark: pgfId-1537548]The Add Suppression dialog box appears.
 
     [bookmark: pgfId-1537549]Step 2 From the Suppression Type drop-down list, select one of the following options:
 
      
       
       	 [bookmark: pgfId-1537550]Select  Rule to completely suppress events for a selected rule.
 
       	 [bookmark: pgfId-1537551]Select  Source to suppress events generated by packets originating from a specified source IP address.
 
       	 [bookmark: pgfId-1537552]Select  Destination to suppress events generated by packets going to a specified destination IP address.
 
      
 
     
 
     [bookmark: pgfId-1537553]Step 3 If you selected Source or Destination for the suppression type, the Network field appears. In the Network field, enter the IP address, an address block, or a comma-separated list comprised of any combination of these. If the intrusion policy is associated with the default action of an access control policy, you can also specify or list a network variable in the default action variable set. 
 
     [bookmark: pgfId-1537557]For information on using IPv4 CIDR and IPv6 prefix length address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1537561]Step 4 Click OK.
 ) next to the rule in the Event Filtering column next the suppressed rule. If you add multiple event filters to a rule, a number over the icon indicates the number of filters. 
     
 
     [bookmark: pgfId-1537566]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1548627][bookmark: 29052]Setting a Dynamic Ru[bookmark: marker-1548623][bookmark: marker-1548624]le Sta[bookmark: marker-1548625]te f[bookmark: marker-1548626]or a Rule
 
     [bookmark: pgfId-1538169]License: Protection
 
     [bookmark: pgfId-1538170]You can set one or more dynamic rule states for a rule from the Rule Detail page. The first dynamic rule state listed has the highest priority. Note that when two dynamic rule states conflict, the action of the first is carried out. For more information on dynamic rule states, see Understanding Dynamic Rule States.
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1538178]To set a dynamic rule state from the rule details:
 
     [bookmark: pgfId-1538182]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1538183]Step 1 Click Add next to Dynamic State.
 
     [bookmark: pgfId-1538184]The Add Rate-Based Rule State dialog box appears.
 
     [bookmark: pgfId-1538185]Step 2 From the Track By drop-down list, select an option to indicate how you want the rule matches tracked: 
 
      
       
       	 [bookmark: pgfId-1538186]Select  Source to track the number of hits for that rule from a specific source or set of sources. 
 
       	 [bookmark: pgfId-1538187]Select  Destination to track the number of hits for that rule to a specific destination or set of destinations. 
 
       	 [bookmark: pgfId-1538188]Select  Rule to track all matches for that rule.
 
      
 
     
 
     [bookmark: pgfId-1538189]Step 3 Optionally, if you set Track By to Source or Destination, enter the IP address of each host you want to track in the Network field.
 
     [bookmark: pgfId-1538195]For information on using IPv4 CIDR and IPv6 prefix length notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1538197]Step 4 Next to Rate, indicate the number of rule matches per time period to set the attack rate:
 
      
       
       	 [bookmark: pgfId-1538198]In the  Count field, using an integer between 0 and 2147483647, specify the number of rule matches you want to use as your threshold.
 
       	 [bookmark: pgfId-1538199]In the  Seconds field, using an integer between 0 and 2147483647, specify the number of seconds that make up the time period for which attacks are tracked.
 
      
 
     
 
     [bookmark: pgfId-1538200]Step 5 From the New State drop-down list, select the new action to be taken when the conditions are met:
 
      
       
       	 [bookmark: pgfId-1538201]Select  Generate Events  to generate an event.
 
       	 [bookmark: pgfId-1538202]Select  Drop and Generate Events  to generate an event and drop the packet that triggered the event in inline deployments or to generate an event in passive deployments.
 
       	 [bookmark: pgfId-1538203]Select  Disabled  to take no action.
 
      
 
     
 
     [bookmark: pgfId-1538204]Step 6 In the Timeout field, using an integer between 1 and 2147483647 (approximately 68 years), type the number of seconds you want the new action to remain in effect. After the timeout occurs, the rule reverts to its original state. Specify 0 to prevent the new action from timing out.
 
     [bookmark: pgfId-1538205]Step 7 Click OK.
 ) next to the rule in the Dynamic State column. If you add multiple dynamic rule state filters to a rule, a number over the icon indicates the number of filters. 
     
 
     [bookmark: pgfId-1538210]If any required fields are blank, you receive an error message indicating which fields you must fill.
 
     [bookmark: pgfId-1538211]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1538216][bookmark: 44947]Setting an SNMP A[bookmark: marker-1538213]lert f[bookmark: marker-1538214]or a[bookmark: marker-1538215] Rule
 
     [bookmark: pgfId-1538223]License: Protection
 
     [bookmark: pgfId-1538224]You can set an SNMP alert for a rule from the Rule Detail page. For more information on SNMP alerts, see Adding SNMP Alerts.
 
     [bookmark: pgfId-1538228]To add an SNMP alert from the rule details:
 
     [bookmark: pgfId-1538232]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1538233]Step 1 Click Add SNMP Alert next to Alerts.
 ) next to the rule in the Alerting column. If you add multiple alerts to a rule, the system includes an indication over the icon of the number of alerts. 
     
 
     [bookmark: pgfId-1538238]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1548739][bookmark: 12931]Adding a Rule Comment for a[bookmark: marker-1548737][bookmark: marker-1548738] Rule
 
     [bookmark: pgfId-1538631]License: Protection
 
     [bookmark: pgfId-1538632]You can add a rule comment for a rule from the Rule Detail page. For more information on rule comments, see Adding Rule Comments. 
 
     [bookmark: pgfId-1538636]To add a comment from the rule details:
 
     [bookmark: pgfId-1538640]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1538641]Step 1 Click Add next to Comments.
 
     [bookmark: pgfId-1538642]The Add Comment dialog box appears.
 
     [bookmark: pgfId-1538643]Step 2 In the Comment field, type the rule comment.
 
     [bookmark: pgfId-1538644]Step 3 Click OK.
 ) next to the rule in the Comments column. If you add multiple comments to a rule, a number over the icon indicates the number of comments. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1538649]Tip To delete a rule comment, click Delete in the rule comments section. Note that you can only delete a comment if the comment is cached with uncommitted intrusion policy changes. After intrusion policy changes are committed, the rule comment is permanent.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1538650]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1548864][bookmark: 72678]Filtering Rules in an I[bookmark: marker-1548862]ntrusion Policy
 
    [bookmark: pgfId-1538788]License: Protection
 
    [bookmark: pgfId-1538790]You can filter the rules you display on the Rules page by a single criteria, or a combination of one or more criteria. 
 
    [bookmark: pgfId-1538791]The filter you construct is shown in the Filter text box. You can click keywords and keyword arguments in the filter panel to construct a filter. When you select multiple keywords, the system combines them using AND logic to create a compound search filter. For example, if you select preprocessor under Category and then select Rule Content > GID and enter 116, you get a filter of Category: “preprocessor” GID:”116” which retrieves all rules that are preprocessor rules and have a GID of 116.
 
    [bookmark: pgfId-1538792]The Category, Microsoft Vulnerabilities, Microsoft Worms, Platform Specific, Preprocessor, and Priority filter groups allow you to submit more than one argument for a keyword, separated by commas. For example, you can press Shift and then select os-linux and os-windows from Category to produce the filter Category:"os-windows,os-linux", which retrieves any rules in the os-linux category or in the os-windows category.
 ). 
    
 ). 
    
 
    [bookmark: pgfId-1538801]For more information, see the following topics:
 
     
     	 [bookmark: pgfId-1538805]Understanding Rule Filtering in an Intrusion Policy
 
     	 [bookmark: pgfId-1538809]Setting a Rule Filter in an Intrusion Policy
 
    
 
     
      [bookmark: pgfId-1548878][bookmark: 38233]Understanding Rule Filtering in an Intrusion Po[bookmark: marker-1548877]licy
 
     [bookmark: pgfId-1538942]License: Protection
 
     [bookmark: pgfId-1538943]Rule filter keywords help you find the rules for which you want to apply rule settings, such as rule states or event filters. You can filter by a keyword and simultaneously select the argument for the keyword by selecting the argument you want from the Rules page filter panel.
 
     [bookmark: pgfId-1538944]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1538948]Guidelines for Constructing Intrusion Policy Rule Filters
 
      	 [bookmark: pgfId-1538952]Understanding Rule Configuration Filters
 
      	 [bookmark: pgfId-1538956]Understanding Rule Content Filters
 
      	 [bookmark: pgfId-1538960]Understanding Rule Categories
 
      	 [bookmark: pgfId-1538964]Editing a Rule Filter Directly
 
     
 
    
 
     
      [bookmark: pgfId-1532211][bookmark: 33103]Guidelines for Constructing Intrusion Policy Rule Filters
 
     [bookmark: pgfId-1539036]License: Protection
 
     [bookmark: pgfId-1539037]In most cases, when you are building a filter, you can use the filter panel to the left of the Rules page in the intrusion policy to select the keywords/arguments you want to use. 
 
     [bookmark: pgfId-1539038]Rule filters are grouped into rule filter groups in the filter panel. Many rule filter groups contain sub-criteria so that you can more easily find the specific rules you are looking for. Some rule filters have multiple levels that you can expand to drill down to individual rules. 
 
     [bookmark: pgfId-1539039]Items in the filter panel sometimes represent filter type groups, sometimes represent keywords, and sometimes represent the argument to a keyword. Use the following rules of thumb to help you build your filters: 
 
      
      	 [bookmark: pgfId-1539040]When you select a filter type group heading that is not a keyword (Rule Configuration, Rule Content, Platform Specific, and Priority), it expands to list the available keywords. 
 
     
 
     [bookmark: pgfId-1539041]When you select a keyword by clicking on a node in the criteria list, a pop-up window appears, where you supply the argument you want to filter by. 
 
     [bookmark: pgfId-1539042]If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword. 
 
     [bookmark: pgfId-1539043]For example, if you click Drop and Generate Events under Rule Configuration > Recommendation in the filter panel, Recommendation:"Drop and Generate Events" is added to the filter text box. If you then click Generate Events under Rule Configuration > Recommendation, the filter changes to Recommendation:"Generate Events".
 
      
      	 [bookmark: pgfId-1539044]When you select a filter type group heading that is a keyword (Category, Classifications, Microsoft Vulnerabilities, Microsoft Worms, Priority, and Rule Update), it lists the available arguments. 
 
     
 
     [bookmark: pgfId-1539045]When you select an item from this type of group, the argument and the keyword it applies to are immediately added to the filter. If the keyword is already in the filter, it replaces the existing argument for the keyword that corresponds to that group. 
 
     [bookmark: pgfId-1539046]For example, if you click os-linux under Category in the filter panel, Category:"os-linux" is added to the filter text box. If you then click os-windows under Category, the filter changes to Category:"os-windows".
 
      
      	 [bookmark: pgfId-1539047]Reference under Rule Content is a keyword, and so are the specific reference ID types listed below it. When you select any of the reference keywords, a pop-up window appears, where you supply an argument and the keyword is added to the existing filter. If the keyword is already in use in the filter, the new argument you supply replaces the existing argument.
 
     
 
     [bookmark: pgfId-1539048]For example, if you click Rule Content > Reference > CVE ID in the filter panel, a pop-up window prompts you to supply the CVE ID. If you enter 2007, then CVE:”2007” is added to the filter text box. In another example, if you click Rule Content > Reference in the filter panel, a pop-up window prompts you to supply the reference. If you enter 2007, then Reference:”2007” is added to the filter text box. 
 
      
      	 [bookmark: pgfId-1539049]When you select rule filter keywords from different groups, each filter keyword is added to the filter and any existing keywords are maintained (unless overridden by a new value for the same keyword). 
 
     
 
     [bookmark: pgfId-1539050]For example, if you click os-linux under Category in the filter panel, Category:"os-linux" is added to the filter text box. If you then click MS00-006 under Microsoft Vulnerabilities, the filter changes to Category:"os-linux" MicrosoftVulnerabilities:"MS00-006".
 
      
      	 [bookmark: pgfId-1539051]When you select multiple keywords, the system combines them using AND logic to create a compound search filter. For example, if you select  preprocessor under  Category and then select  Rule Content > GID  and enter  116 , you get a filter of  Category: “preprocessor” GID:”116” , which retrieves all rules that are preprocessor rules  and have a GID of 116.
 
      	 [bookmark: pgfId-1539052]The Category, Microsoft Vulnerabilities, Microsoft Worms, Platform Specific, and Priority filter groups allow you to submit more than one argument for a keyword, separated by commas. For example, you can press Shift and then select  os-linux and  os-windows from  Category to produce the filter  Category:"os-windows,app-detect" , which retrieves any rules in the  os-linux category or in the  os-windows category.
 
     
 
     [bookmark: pgfId-1532356]The same rule may be retrieved by more than one filter keyword/argument pair. For example, the DOS Cisco attempt rule (SID 1545) appears if rules are filtered by the dos category, and also if you filter by the High priority.
 
      
       
     
 
     
 
     [bookmark: pgfId-1539220]Note The Cisco VRT may use the rule update mechanism to add and remove rule filters.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1556461]Table 32-4 [bookmark: 32731]Rule Filter Groups 
 
        
        
         
         	 
           
           [bookmark: pgfId-1556471]Filter Group 
          
  
         	 
           
           [bookmark: pgfId-1556473]Description 
          
  
         	 
           
           [bookmark: pgfId-1556475]Multiple Argument Support? 
          
  
         	 
           
           [bookmark: pgfId-1556477]Heading is... 
          
  
         	 
           
           [bookmark: pgfId-1556479]Items in List are... 
          
  
        
 
         
         	[bookmark: pgfId-1556481]Rule Configuration
  
         	[bookmark: pgfId-1556483]Finds rules according to the configuration of the rule. See Understanding Rule Configuration Filters.
  
         	[bookmark: pgfId-1556488]No
  
         	[bookmark: pgfId-1556490]A grouping
  
         	[bookmark: pgfId-1556492]keywords
  
        
 
         
         	[bookmark: pgfId-1556494]Rule Content
  
         	[bookmark: pgfId-1556496]Finds rules according to the content of the rule. See Understanding Rule Content Filters.
  
         	[bookmark: pgfId-1556501]No
  
         	[bookmark: pgfId-1556503]A grouping
  
         	[bookmark: pgfId-1556505]keywords
  
        
 
         
         	[bookmark: pgfId-1556507]Category
  
         	[bookmark: pgfId-1556509]Finds rules according to the rule categories used by the rule editor. Note that local rules appear in the local sub-group. See Understanding Rule Categories.
  
         	[bookmark: pgfId-1556514]Yes
  
         	[bookmark: pgfId-1556516]A keyword
  
         	[bookmark: pgfId-1556518]arguments
  
        
 
         
         	[bookmark: pgfId-1556520]Classifications
  
         	[bookmark: pgfId-1556522]Finds rules according to the attack classification that appears in the packet display of an event generated by the rule. See Searching for Intrusion Events and Defining the Intrusion Event Classification.
  
         	[bookmark: pgfId-1556530]No
  
         	[bookmark: pgfId-1556532]A keyword
  
         	[bookmark: pgfId-1556534]arguments
  
        
 
         
         	[bookmark: pgfId-1556536]Microsoft Vulnerabilities
  
         	[bookmark: pgfId-1556538]Finds rules according to Microsoft bulletin number.
  
         	[bookmark: pgfId-1556540]Yes
  
         	[bookmark: pgfId-1556542]A keyword
  
         	[bookmark: pgfId-1556544]arguments
  
        
 
         
         	[bookmark: pgfId-1556546]Microsoft Worms
  
         	[bookmark: pgfId-1556548]Finds rules based on specific worms that affect Microsoft Windows hosts.
  
         	[bookmark: pgfId-1556550]Yes
  
         	[bookmark: pgfId-1556552]A keyword
  
         	[bookmark: pgfId-1556554]arguments
  
        
 
         
         	[bookmark: pgfId-1556556]Platform Specific
  
         	[bookmark: pgfId-1556558]Finds rules according to their relevance to specific versions of operating systems. 
 [bookmark: pgfId-1556559]Note that a rule may affect more than one operating system or more than one version of an operating system. For example, enabling SID 2260 affects multiple versions of Mac OS X, IBM AIX, and other operating systems.
  
         	[bookmark: pgfId-1556561]Yes
  
         	[bookmark: pgfId-1556563]A keyword
  
         	[bookmark: pgfId-1556565]arguments
 [bookmark: pgfId-1556566]Note that if you pick one of the items from the sub-list, it adds a modifier to the argument.
  
        
 
         
         	[bookmark: pgfId-1556568]Preprocessors
  
         	[bookmark: pgfId-1556570]Finds rules for individual preprocessors.
 [bookmark: pgfId-1556571]Note that you must enable preprocessor rules associated with a preprocessor option to generate events for the option when the preprocessor is enabled; see Setting Rule States.
  
         	[bookmark: pgfId-1556576]Yes
  
         	[bookmark: pgfId-1556578]A grouping
  
         	[bookmark: pgfId-1556580]sub-groupings
  
        
 
         
         	[bookmark: pgfId-1556582]Priority
  
         	[bookmark: pgfId-1556584]Finds rules according to high, medium, and low priorities.
 [bookmark: pgfId-1556585]The classification assigned to a rule determines its priority. These groups are further grouped into rule categories. Note that local rules (that is, rules that you create) do not appear in the priority groups.
  
         	[bookmark: pgfId-1556587]Yes
  
         	[bookmark: pgfId-1556589]A keyword
  
         	[bookmark: pgfId-1556591]arguments
 [bookmark: pgfId-1556592]Note that if you pick one of the items from the sub-list, it adds a modifier to the argument.
  
        
 
         
         	[bookmark: pgfId-1556594]Rule Update
  
         	[bookmark: pgfId-1556596]Finds rules added or modified through a specific rule update. For each rule update, view all rules in the update, only new rules imported in the update, or only existing rules changed by the update.
  
         	[bookmark: pgfId-1556598]No
  
         	[bookmark: pgfId-1556600]A keyword
  
         	[bookmark: pgfId-1556602]arguments
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1532212][bookmark: 21239]Understanding Rule Configuration Filters
 
     [bookmark: pgfId-1539495]License: Protection
 
     [bookmark: pgfId-1539496]You can filter the rules listed in the Rules page by several rule configuration settings. For example, if you want to view the set of rules whose rule state does not match the recommended rule state, you can filter on rule state by selecting Does not match recommendation.
 
     [bookmark: pgfId-1539497]When you select a keyword by clicking on a node in the criteria list, a pop-up window appears, where you supply the argument you want to filter by. 
 
     [bookmark: pgfId-1539498]If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword. 
 
     [bookmark: pgfId-1539499]For example, if you click Drop and Generate Events under Rule Configuration > Recommendation in the filter panel, Recommendation:"Drop and Generate Events" is added to the filter text box. If you then click Generate Events under Rule Configuration > Recommendation, the filter changes to Recommendation:"Generate Events".
 
     [bookmark: pgfId-1539500]See the following procedures for more information on the rule configuration settings you can use to filter.
 
     [bookmark: pgfId-1539502][bookmark: 80286]To use the Rule State filter:
 
     [bookmark: pgfId-1539506]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1539507]Step 1 Under Rule Configuration, click Rule State.
 
     [bookmark: pgfId-1539508]Step 2 From the Rule State drop-down list, select the rule state to filter by: 
 
      
       
       	 [bookmark: pgfId-1539509]To find rules that only generate events, select  Generate Events , then click  OK . 
 
       	 [bookmark: pgfId-1539510]To find rules that are set to generate events and drop the matching packet, select  Drop and Generate Events , then click  OK . 
 
       	 [bookmark: pgfId-1539511]To find disabled rules, select  Disabled , then click  OK . 
 
       	 [bookmark: pgfId-1539512]To find rules whose rule state does not match the recommended state, select  Does not match recommendation , then click  OK . 
 
      
 
     
 
     [bookmark: pgfId-1539513]The Rules page updates to display rules according to current rule state.
 
     [bookmark: pgfId-1539514]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1539515]To use the Recommendation filter:
 
     [bookmark: pgfId-1539519]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1539520]Step 1 Under Rule Configuration, click Recommendation.
 
     [bookmark: pgfId-1539524]Step 2 From the Recommendation drop-down list, select the FireSIGHT rule state recommendation to filter by, then click OK. 
 
     [bookmark: pgfId-1539525]The Rules page updates to display rules according to recommended rule state.
 
     [bookmark: pgfId-1539526]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1539527]To use the Threshold filter:
 
     [bookmark: pgfId-1539531]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1539532]Step 1 Under Rule Configuration, click Threshold.
 
     [bookmark: pgfId-1539533]Step 2 From the Threshold drop-down list, select the threshold setting to filter by: 
 
      
       
       	 [bookmark: pgfId-1539534]To find rules with a threshold type of  limit , select  Limit , then click  OK . 
 
       	 [bookmark: pgfId-1539535]To find rules with a threshold type of  threshold , select  Threshold , then click  OK . 
 
       	 [bookmark: pgfId-1539536]To find rules with a threshold type of  both , select  Both , then click  OK . 
 
       	 [bookmark: pgfId-1539537]To find rules with thresholds tracked by  source , select  Source , then click  OK . 
 
       	 [bookmark: pgfId-1539538]To find rules with thresholds tracked by  destination , select  Destination , then click  OK . 
 
       	 [bookmark: pgfId-1539539]To find any rule with a threshold set, select  All , then click  OK . 
 
      
 
     
 
     [bookmark: pgfId-1539540]The Rules page updates to display rules where the type of threshold indicated in the filter has been applied to the rule.
 
     [bookmark: pgfId-1539541]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1539542]To use the Suppression filter:
 
     [bookmark: pgfId-1539546]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1539547]Step 1 Under Rule Configuration, click Suppression.
 
     [bookmark: pgfId-1539548]Step 2 From the Suppression drop-down list, select the suppression setting to filter by: 
 
      
       
       	 [bookmark: pgfId-1539549]To find rules where events are suppressed for packets inspected by that rule, select  By Rule , then click  OK . 
 
       	 [bookmark: pgfId-1539550]To find rules where events are suppressed based on the source of the traffic, select  By Source , then click  OK . 
 
       	 [bookmark: pgfId-1539551]To find rules where events are suppressed based on the destination of the traffic, select  By Destination , then click  OK . 
 
       	 [bookmark: pgfId-1539552]To find any rule with suppression set, select  All , then click  OK . 
 
      
 
     
 
     [bookmark: pgfId-1539553]The Rules page updates to display rules where the type of suppression indicated in the filter has been applied to the rule.
 
     [bookmark: pgfId-1539554]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1539555]To use the Dynamic State filter:
 
     [bookmark: pgfId-1539559]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1539560]Step 1 Under Rule Configuration, click Dynamic State.
 
     [bookmark: pgfId-1539561]Step 2 From the Dynamic State drop-down list, select the suppression setting to filter by: 
 
      
       
       	 [bookmark: pgfId-1539562]To find rules where a dynamic state is configured for packets inspected by that rule, select  By Rule , then click  OK . 
 
       	 [bookmark: pgfId-1539563]To find rules where a dynamic state is configured for packets based on the source of the traffic, select  By Source , then click  OK . 
 
       	 [bookmark: pgfId-1539564]To find rules where a dynamic state is configured based on the destination of the traffic, select  By Destination , then click  OK . 
 
       	 [bookmark: pgfId-1539565]To find rules where a dynamic state of  Generate Events is configured, select  Generate Events , then click  OK . 
 
       	 [bookmark: pgfId-1539566]To find rules where a dynamic state of  Drop and Generate Events is configured, select  Drop and Generate Events , then click  OK . 
 
       	 [bookmark: pgfId-1539567]To find where a dynamic state of  Disabled is configured, select  Disabled , then click  OK . 
 
       	 [bookmark: pgfId-1539568]To find any rule with suppression set, select  All , then click  OK . 
 
      
 
     
 
     [bookmark: pgfId-1539569]The Rules page updates to display rules where the dynamic rule state indicated in the filter has been applied to the rule.
 
     [bookmark: pgfId-1539570]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1540410]To use the Alert filter:
 
     [bookmark: pgfId-1540414]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1559829]Step 1 Under Rule Configuration, click Alert.
 
     [bookmark: pgfId-1559830]Step 2 From the Alert drop-down list, select the alert setting to filter by: SNMP.
 
     [bookmark: pgfId-1559872]Step 3 Click OK.
 
     [bookmark: pgfId-1540417]The Rules page updates to display rules where you have applied an alert filter.
 
     [bookmark: pgfId-1540418]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1539571]To use the Comment filter:
 
     [bookmark: pgfId-1539575]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1539576]Step 1 Under Rule Configuration, click Comment.
 
     [bookmark: pgfId-1539577]Step 2 In the Comment field, type the string of comment text to filter by, then click OK. 
 
     [bookmark: pgfId-1539578]The Rules page updates to display rules where comments applied to the rule contain the string indicated in the filter.
 
     [bookmark: pgfId-1539579]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1539581][bookmark: 45895]Understanding Rule Content Filters
 
     [bookmark: pgfId-1539588]License: Protection
 
     [bookmark: pgfId-1539589]You can filter the rules listed in the Rules page by several rule content items. For example, you can quickly retrieve a rule by searching for the rule’s SID. You can also find all rules that inspect traffic going to a specific destination port. 
 
     [bookmark: pgfId-1539590]When you select a keyword by clicking on a node in the criteria list, a pop-up window appears, where you supply the argument you want to filter by. 
 
     [bookmark: pgfId-1539591]If that keyword is already used in the filter, the argument you supply replaces the existing argument for that keyword.
 
     [bookmark: pgfId-1539592]For example, if you click SID under Rule Content in the filter panel, a pop-up window appears, prompting you to supply a SID. If you type 1045, then SID:”1045”is added to the filter text box. If you then click SID again and change the SID filter to 1044, the filter changes to SID:”1044”.
 
     [bookmark: pgfId-1539593]For more information on the rule content you can use to filter, see the following table.
 
     [bookmark: pgfId-1539696]
 
      
       
        
        [bookmark: pgfId-1539600]Table 32-5 [bookmark: 26184]Rule Content Filters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1539606]To use this filter, click... 
          
  
         	 
           
           [bookmark: pgfId-1539608]Then... 
          
  
         	 
           
           [bookmark: pgfId-1539610]Result 
          
  
        
 
         
         	[bookmark: pgfId-1539612]Message
  
         	[bookmark: pgfId-1539614]Type the message string to filter by, then click OK. 
  
         	[bookmark: pgfId-1539616]Finds rules that contain the supplied string in the message field.
  
        
 
         
         	[bookmark: pgfId-1539618]SID
  
         	[bookmark: pgfId-1539620]Type the SID number to filter by, then click OK. 
  
         	[bookmark: pgfId-1539622]Finds rules that have the specified SID.
  
        
 
         
         	[bookmark: pgfId-1539624]GID
  
         	[bookmark: pgfId-1539626]Type the GID number to filter by, then click OK. 
  
         	[bookmark: pgfId-1539628]Finds rules that have the specified GID.
  
        
 
         
         	[bookmark: pgfId-1539630]Reference
  
         	[bookmark: pgfId-1539632]Type the reference string to filter by, then click OK. 
 [bookmark: pgfId-1540981]To enter a string for a specific type of reference that you want to filter by, select CVE ID, URL, Bugtraq ID, Nessus ID, Arachnids ID, or Mcafee ID, then type a string and click OK. 
  
         	[bookmark: pgfId-1539634]Finds rules that contain the supplied string in the reference field.
  
        
 
         
         	[bookmark: pgfId-1539636]Action
  
         	[bookmark: pgfId-1539638]Select the action to filter by: 
 
           
           	 [bookmark: pgfId-1539639]To find alert rules, select  Alert , then click  OK . 
 
           	 [bookmark: pgfId-1539640]To find pass rules, select  Pass , then click  OK . 
 
          
  
         	[bookmark: pgfId-1539642]Finds rules that start with alert or pass.
  
        
 
         
         	[bookmark: pgfId-1539644]Protocol
  
         	[bookmark: pgfId-1539646]Select the protocol to filter by: ICMP, IP, TCP, or UDP; then click OK.
  
         	[bookmark: pgfId-1539648]Finds rules that include the selected protocol.
  
        
 
         
         	[bookmark: pgfId-1539650]Direction
  
         	[bookmark: pgfId-1539652]Select a directional setting to filter by:
 
           
           	 [bookmark: pgfId-1539653]To find rules that inspect traffic moving in a specific direction, select  Directional , then click  OK . 
 
           	 [bookmark: pgfId-1539654]To find rules that inspect traffic moving in either direction between a source and destination, select  Bidirectional , then click  OK .
 
          
  
         	[bookmark: pgfId-1539656]Finds rules based on whether the rule includes the indicated directional setting.
  
        
 
         
         	[bookmark: pgfId-1539658]Source IP
  
         	[bookmark: pgfId-1539660]Type the source IP address to filter by, then click OK. 
 [bookmark: pgfId-1539661]Note that you can filter by a valid IP address, a CIDR block/prefix length, or using variables such as $HOME_NET or $EXTERNAL_NET.
  
         	[bookmark: pgfId-1539663]Finds rules that use the specified addresses or variables for the source IP address designation in the rule.
  
        
 
         
         	[bookmark: pgfId-1539665]Destination IP
  
         	[bookmark: pgfId-1539667]Type the destination IP address to filter by, then click OK. 
 [bookmark: pgfId-1539668]Note that you can filter by a valid IP address, a CIDR block/prefix length, or using variables such as $HOME_NET or $EXTERNAL_NET.
  
         	[bookmark: pgfId-1539670]Finds rules that use the specified addresses or variables for the source IP address designation in the rule.
  
        
 
         
         	[bookmark: pgfId-1539672]Source port
  
         	[bookmark: pgfId-1539674]Type the source port to filter by, then click OK. 
 [bookmark: pgfId-1541460]The port value must be an integer between 1 and 65535 or a port variable.
  
         	[bookmark: pgfId-1539676]Finds rules that include the specified source port.
  
        
 
         
         	[bookmark: pgfId-1539678]Destination port
  
         	[bookmark: pgfId-1539680]Type the destination port to filter by, then click OK.
 [bookmark: pgfId-1541481]The port value must be an integer between 1 and 65535 or a port variable.
  
         	[bookmark: pgfId-1539682]Finds rules that include the specified destination port.
  
        
 
         
         	[bookmark: pgfId-1539684]Rule Overhead
  
         	[bookmark: pgfId-1539686]Select the amount of rule overhead to filter by: Low, Medium, High, or Very High; then click OK.
  
         	[bookmark: pgfId-1539688]Finds rules with the selected rule overhead.
  
        
 
         
         	[bookmark: pgfId-1539690]Metadata
  
         	[bookmark: pgfId-1539692]Type the metadata key-value pair to filter by, separated by a space; then click OK.
 [bookmark: pgfId-1539693]For example, type metadata:”service http” to locate rules with metadata relating to the HTTP application protocol. 
  
         	[bookmark: pgfId-1539695]Find rules with metadata containing the matching key-value pair.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1532214][bookmark: 56915]Understanding Rule Categories[bookmark: marker-1548892]
 
     [bookmark: pgfId-1541780]License: Protection
 
     [bookmark: pgfId-1541785]The FireSIGHT System places rules in categories based on the type of traffic the rule detects. On the Rules page, you can filter by rule category, so you can set a rule attribute for all rules in a category. For example, if you do not have Linux hosts on your network, you could filter by the os-linux category, then disable all the rules showing to disable the entire os-linux category.
 
     [bookmark: pgfId-1541786]You can hover your pointer over a category name to display the number of rules in that category.
 
      
       
     
 
     
 
     [bookmark: pgfId-1541790]Note The Cisco VRT may use the rule update mechanism to add and remove rule categories.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532215][bookmark: 53047]Editing a Rule F[bookmark: marker-1548905]ilter Directly
 
     [bookmark: pgfId-1541858]License: Protection
 
     [bookmark: pgfId-1541859]You can edit your filter to modify the special keywords and their arguments that are supplied when you click on a filter in the filter panel. Custom filters on the Rules page function like those used in the rule editor, but you can also use any of the keywords supplied in the Rules page filter, using the syntax displayed when you select the filter through the filter panel. To determine a keyword for future use, click on the appropriate argument in the filter panel on the right. The filter keyword and argument syntax appear in the filter text box. 
 
     [bookmark: pgfId-1541862]To see lists of arguments for keywords which only support specific values, see Understanding Rule Configuration Filters, Understanding Rule Content Filters, and Understanding Rule Categories. Remember that comma-separated multiple arguments for a keyword are only supported for the Category and Priority filter types. 
 
     [bookmark: pgfId-1541870]You can use keywords and arguments, character strings, and literal character strings in quotes, with spaces separating multiple filter conditions. A filter cannot include regular expressions, wild card characters, or any special operator such as a negation character (!), a greater than symbol (>), less than symbol (<), and so on. When you type in search terms without a keyword, without initial capitalization of the keyword, or without quotes around the argument, the search is treated as a string search and the category, message, and SID fields are searched for the specified terms.
 
     [bookmark: pgfId-1541871]All keywords, keyword arguments, and character strings are case-insensitive. Except for the gid and sid keywords, all arguments and strings are treated as partial strings. Arguments for gid and sid return only exact matches.
 
     [bookmark: pgfId-1541872]Each rule filter can include one or more keywords in the format:
 
      
      [bookmark: pgfId-1541938]Keyword:”argument” 
     
 
     [bookmark: pgfId-1541942]where keyword is one of the keywords in the filter groups described in the Rule types table and argument is enclosed in double quotes and is a single, case-insensitive, alphanumeric string to search for in the specific field or fields relevant to the keyword. Note that keywords should be typed with initial capitalization.
 
     [bookmark: pgfId-1541943]Arguments for all keywords except gid and sid are treated as partial strings. For example, the argument 123 returns "12345", "41235", "45123", and so on. The arguments for gid and sid return only exact matches; for example, sid:3080 returns only SID 3080.
 
     [bookmark: pgfId-1541944]Each rule filter can also include one or more alphanumeric character strings. Character strings search the rule Message field, Signature ID, and Generator ID. For example, the string 123 returns the strings "Lotus123", "123mania", and so on in the rule message, and also returns SID 6123, SID 12375, and so on. For information on the rule Message field, see Defining the Event Message. For information on rule SIDs and GIDs, see Reading Preprocessor Generator IDs. You can search for a partial SID by filtering with one or more character strings. 
 
     [bookmark: pgfId-1541951]All character strings are case-insensitive and are treated as partial strings. For example, any of the strings ADMIN, admin, or Admin return "admin", "CFADMIN", "Administrator" and so on.
 
     [bookmark: pgfId-1541952]You can enclose character strings in quotes to return exact matches. For example, the literal string "overflow attempt" in quotes returns only that exact string, whereas a filter comprised of the two strings overflow and attempt without quotes returns "overflow attempt", "overflow multipacket attempt", "overflow with evasion attempt", and so on.
 
     [bookmark: pgfId-1541954][bookmark: 60128]You can narrow filter results by entering any combination of keywords, character strings, or both, separated by spaces. The result includes any rule that matches all the filter conditions.
 
     [bookmark: pgfId-1541955]You can enter multiple filter conditions in any order. For example, each of the following filters returns the same rules:
 
      
      	 [bookmark: pgfId-1541956] url:at login attempt cve:200 
 
      	 [bookmark: pgfId-1541957] login attempt cve:200 url:at 
 
      	 [bookmark: pgfId-1541958] login cve:200 attempt url:at 
 
     
 
    
 
     
      [bookmark: pgfId-1532216][bookmark: 50099]Setting a Rule Filt[bookmark: marker-1548918]er in an Intrusion Policy
 
     [bookmark: pgfId-1542047]License: Protection
 
     [bookmark: pgfId-1542048]You can filter the rules on the Rules page to display a subset of rules. You can then use any of the page features, including selecting any of the features available in the context menu. This can be useful, for example, when you want to set a threshold for all the rules in a specific category. You can use the same features with rules in a filtered or unfiltered list. For example, you can apply new rule states to rules in a filtered or unfiltered list. 
 
     [bookmark: pgfId-1542049]You can select predefined filter keywords from the filter panel on the left side of the Rules page in the intrusion policy. When you select a filter, the page displays all matching rules, or indicates when no rules match. 
 
     [bookmark: pgfId-1542050]For more information on all the keywords and arguments you can use and how you can construct filters from the filter panel, see Understanding Rule Filtering in an Intrusion Policy.
 
     [bookmark: pgfId-1542054]You can add keywords to a filter to further constrain it. Any filter you enter searches the entire rules database and returns all matching rules. When you enter a filter while the page still displays the result of a previous filter, the page clears and returns the result of the new filter instead. 
 
     [bookmark: pgfId-1542131]You can also type a filter using the same keyword and argument syntax supplied when you select a filter, or modify argument values in a filter after you select it. When you type in search terms without a keyword, without initial capitalization of the keyword, or without quotes around the argument, the search is treated as a string search and the category, message, and SID fields are searched for the specified terms.
 
     [bookmark: pgfId-1542132]To filter for specific rules in an intrusion policy:
 
     [bookmark: pgfId-1542136]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1542137]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1542138]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1542143]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1542147]The Policy Information page appears.
 
     [bookmark: pgfId-1542149]Step 3 [bookmark: 58772]Click Rules.
 
     [bookmark: pgfId-1542150]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
     [bookmark: pgfId-1542151]Step 4 Construct a filter by clicking on keywords or arguments in the filter panel on the left. Note that if you click an argument for a keyword already in the filter, it replaces the existing argument. See the following for more information:
 
      
       
       	 [bookmark: pgfId-1542155]Guidelines for Constructing Intrusion Policy Rule Filters
 
       	 [bookmark: pgfId-1542159]Understanding Rule Configuration Filters
 
       	 [bookmark: pgfId-1542163]Understanding Rule Content Filters
 
       	 [bookmark: pgfId-1542167]Understanding Rule Categories
 
       	 [bookmark: pgfId-1542171]Editing a Rule Filter Directly
 
      
 
     
 
     [bookmark: pgfId-1542172]The page refreshes to display all matching rules, and the number of rules matching the filter is displayed above the filter text box.
 
     [bookmark: pgfId-1542173]Step 5 Select the rule or rules where you want to apply a new setting. You have the following options:
 
      
       
       	 [bookmark: pgfId-1542174]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1542175]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1542176]Step 6 Optionally, make any changes to the rule that you would normally make on the page. See the following sections for more information:
 
      
       
       	 [bookmark: pgfId-1542180]See Setting Rule States for information on enabling and disabling rules on the Rules page.
 
       	 [bookmark: pgfId-1542184]See Filtering Intrusion Event Notification Per Policy for information on adding thresholding and suppression to rules.
 
       	 [bookmark: pgfId-1542188]See Adding Dynamic Rule States for information on setting dynamic rule states that trigger when rate anomalies occur in matching traffic.
 
       	 [bookmark: pgfId-1542192]See Adding SNMP Alerts for information on adding SNMP alerts to specific rules.
 
       	 [bookmark: pgfId-1542196]See Adding Rule Comments for information on adding rule comments to rules.
 
      
 
     
 
     [bookmark: pgfId-1542197]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
     [bookmark: pgfId-1571666]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1542201]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532217][bookmark: 80766]Setting Rule State[bookmark: marker-1548936]s
 
    [bookmark: pgfId-1542327]License: Protection
 
    [bookmark: pgfId-1542331]The Cisco Vulnerability Research Team (VRT) sets the default state of each intrusion and preprocessor rule in each default policy. For example, a rule may be enabled in the Security over Connectivity default policy and disabled in the Connectivity over Security default policy. Intrusion policy rules you create inherit the default states of the rules in the default policy you use to create your policy.
 
    [bookmark: pgfId-1542332]You can set a rule to Generate Events, to Drop and Generate Events, or to Disable individually, or you can filter the rules by a variety of factors to select the rules for which you want to modify the state. In an inline deployment, you can use the Drop and Generate Events rule state in inline intrusion deployments to drop malicious packets. Note that rules with the Drop and Generate Events rule state generate events but do not drop packets in a passive deployment, including when a 3D9900 or Series 3 device inline interface set is in tap mode. Setting a rule to Generate Events or to Drop and Generate Events enables the rule; setting the rule to Disable disables it.
 
    [bookmark: pgfId-1542336]Consider two scenarios. In the first scenario, the rule state for a specific rule is set to Generate Events. When a malicious packet crosses your network and triggers the rule, the packet is sent to its destination and the system generates an intrusion event. In the second scenario, assume that the rule state for the same rule is set to Drop and Generate Events in an inline deployment. In this case, when the malicious packet crosses the network, the system drops the malicious packet and generates an intrusion event. The packet never reaches its target. 
 
    [bookmark: pgfId-1542394]In an intrusion policy, you can set a rule’s state to one of the following:
 
     
     	 [bookmark: pgfId-1542395]Set the rule state to  Generate Events  if you want the system to detect a specific intrusion attempt and generate an intrusion event when it finds matching traffic.
 
     	 [bookmark: pgfId-1542396]Set the rule state to  Drop and Generate Events  if you want the system to detect a specific intrusion attempt, then drop the packet containing the attack and generate an intrusion event when it finds matching traffic in an inline deployment, or to generate an intrusion event when it finds matching traffic in a passive deployment, including when a 3D9900 or Series 3 device inline interface set is in tap mode.
 
    
 
    [bookmark: pgfId-1549511]Note that for the system to drop packets, your intrusion policy must be set to drop rules in an inline deployment; see Setting Drop Behavior in an Inline Deployment for more information.
 
     
     	 [bookmark: pgfId-1549515]Set the rule state to  Disable if you do not want the system to evaluate matching traffic.
 
    
 
    [bookmark: pgfId-1542405]To use drop rules, you must:
 
     
     	 [bookmark: pgfId-1542406]Enable the  Drop when Inline option in your intrusion policy.
 
     	 [bookmark: pgfId-1542407]Set the rule state to  Drop and Generate Events for any rules that should drop all packets that match the rule.
 
     	 [bookmark: pgfId-1542408]Apply an access control policy that includes an access control rule that is associated with your intrusion policy to a managed device that uses an inline set.
 
    
 
    [bookmark: pgfId-1542409]Filtering rules on the Rules page can help you find the rules you want to set as drop rules. For more information, see Filtering Rules in an Intrusion Policy.
 
    [bookmark: pgfId-1542416]See Understanding and Writing Intrusion Rules for information about rule anatomy, rule keywords and their options, and rule writing syntax.
 
    [bookmark: pgfId-1542510]The VRT sometimes uses a rule update to change the default state of one or more rules in a default policy. If you allow rule updates to update your base policy, you also allow the rule update to change the default state of a rule in your policy when the default state changes in the default policy you used to create your policy (or in the default policy it is based on). Note, however, that if you have changed the rule state, the rule update does not override your change.
 
    [bookmark: pgfId-1542511]To change the rule state for one or more rules:
 
    [bookmark: pgfId-1542515]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1542516]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1542517]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1542522]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1542526]The Policy Information page appears.
 
    [bookmark: pgfId-1542527]Note that this page indicates the total number of enabled rules, the total number of enabled rules set to Generate Events, and the total number set to Drop and Generate Events. Note also that in a passive deployment, rules set to Drop and Generate Events only generate events.
 
    [bookmark: pgfId-1542529]Step 3 [bookmark: 27150]Click Rules.
 
    [bookmark: pgfId-1542530]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
    [bookmark: pgfId-1542531]Step 4 Locate the rule or rules where you want to set the rule state. You have the following options:
 
     
      
      	 [bookmark: pgfId-1542532]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
      	 [bookmark: pgfId-1542533]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
     
 
    
 
    [bookmark: pgfId-1542540]The page refreshes to display all matching rules.
 
    [bookmark: pgfId-1542541]Step 5 Select the rule or rules where you want to set the rule state. You have the following options:
 
     
      
      	 [bookmark: pgfId-1542542]To select a specific rule, select the check box next to the rule.
 
      	 [bookmark: pgfId-1542543]To select all the rules in the current list, select the check box at the top of the column.
 
     
 
    
 
    [bookmark: pgfId-1542544]Step 6 You have the following options:
 
     
      
      	 [bookmark: pgfId-1542545]To generate events when traffic matches the selected rules, select  Rule State > Generate Events .
 
      	 [bookmark: pgfId-1542546]To generate events and drop the traffic in inline deployments when traffic matches the selected rules, select  Rule State > Drop and Generate Events .
 
      	 [bookmark: pgfId-1542547]To not inspect traffic matching the selected rules, select  Rule State > Disable .
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1542553]Note [bookmark: 14082][bookmark: 84509]Cisco strongly recommends that you do not enable all the intrusion rules in an intrusion policy. The performance of your managed device is likely to degrade if all rules are enabled. Instead, tune your rule set to match your network environment as closely as possible.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1542554]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
    [bookmark: pgfId-1542558]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1532218][bookmark: 38828]Filtering [bookmark: marker-1548949]Intrusion Event Notification Per Policy
 
    [bookmark: pgfId-1542694]License: Protection
 
    [bookmark: pgfId-1542695]The importance of an intrusion event can be based on frequency of occurrence, or on source or destination IP address. In some cases you may not care about an event until it has occurred a certain number of times. For example, you may not be concerned if someone attempts to log into a server until they fail a certain number of times. In other cases, you may only need to see a few occurrences to know there is a widespread problem. For example, if a DoS attack is launched against your web server, you may only need to see a few occurrences of an intrusion event to know that you need to address the situation. Seeing hundreds of the same event only overwhelms your system. 
 
    [bookmark: pgfId-1542696]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1542700]Configuring Event Thresholding explains how to set thresholds that dictate how often an event is displayed, based on the number of occurrences. You can configure thresholding per event and per policy.
 
     	 [bookmark: pgfId-1542704]Configuring Suppression Per Intrusion Policy explains how to suppress notification of specified events per source or destination IP address, per policy.
 
    
 
     
      [bookmark: pgfId-1543030][bookmark: 86762]Configu[bookmark: marker-1543027]ring Event Thres[bookmark: RuleThresholdingGlobal]holding
 
     [bookmark: pgfId-1543038]License: Protection
 
     [bookmark: pgfId-1543039]You can set thresholds for individual rules, per intrusion policy, to limit the number of times the system logs and displays an intrusion event based on how many times the event is generated within a specified time period. This can prevent you from being overwhelmed with a large number of identical events. You can set thresholds per shared object rule, standard text rule, or preprocessor rule.
 
     [bookmark: pgfId-1543046]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1543050]Understanding Event Thresholding
 
      	 [bookmark: pgfId-1543054]Adding and Modifying Intrusion Event Thresholds
 
      	 [bookmark: pgfId-1543058]Viewing and Deleting Intrusion Event Thresholds
 
      	 [bookmark: pgfId-1543062]Setting a Threshold for a Rule
 
     
 
    
 
     
      [bookmark: pgfId-1543139][bookmark: 51505]Understanding Event Thresholding
 
     [bookmark: pgfId-1543146]License: Protection
 
     [bookmark: pgfId-1543147]First, you must specify the thresholding type. You can select from the options discussed in the following table.
 
     [bookmark: pgfId-1543176]
 
      
       
        
        [bookmark: pgfId-1543154]Table 32-6 [bookmark: 69467]Thresholding Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1543158]Option 
          
  
         	 
           
           [bookmark: pgfId-1543160]Description 
          
  
        
 
         
         	[bookmark: pgfId-1543162]Limit
  
         	[bookmark: pgfId-1543164]Logs and displays events for the specified number of packets (specified by the Count argument) that trigger the rule during the specified time period. For example, if you set the type to Limit, the Count to 10, and the Seconds to 60, and 14 packets trigger the rule, the system stops logging events for the rule after displaying the first 10 that occur within the same minute.
  
        
 
         
         	[bookmark: pgfId-1543166]Threshold
  
         	[bookmark: pgfId-1543168]Logs and displays a single event when the specified number of packets (specified by the Count argument) trigger the rule during the specified time period. Note that the counter for the time restarts after you hit the threshold count of events and the system logs that event. For example, you set the type to Threshold, Count to 10, and Seconds to 60, and the rule triggers 10 times by second 33. The system generates one event, then resets the Seconds and Count counters to 0. The rule then triggers another 10 times in the next 25 seconds. Because the counters reset to 0 at second 33, the system logs another event.
  
        
 
         
         	[bookmark: pgfId-1543170]Both
  
         	[bookmark: pgfId-1543172]Logs and displays an event once per specified time period, after the specified number (count) of packets trigger the rule. For example, if you set the type to Both, Count to two, and Seconds to 10, the following event counts result:
 
           
           	 [bookmark: pgfId-1543173]If the rule is triggered once in 10 seconds, the system does not generate any events (the threshold is not met)
 
           	 [bookmark: pgfId-1543174]If the rule is triggered twice in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time)
 
           	 [bookmark: pgfId-1543175]If the rule is triggered four times in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time, and following events are ignored)
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1543177]Next, you must specify tracking, which determines whether the event threshold is calculated per source or destination IP address. Select one of the options from the following table to specify how the system tracks event instances. 
 
     [bookmark: pgfId-1543199]
 
      
       
        
        [bookmark: pgfId-1543184]Table 32-7 [bookmark: 36517]Thresholding IP Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1543188]Option 
          
  
         	 
           
           [bookmark: pgfId-1543190]Description 
          
  
        
 
         
         	[bookmark: pgfId-1543192]Source
  
         	[bookmark: pgfId-1543194]Calculates event instance count per source IP address.
  
        
 
         
         	[bookmark: pgfId-1543196]Destination
  
         	[bookmark: pgfId-1543198]Calculates event instance count per destination IP address.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1543200]Finally, you must specify the number of instances and time period that define the threshold.
 
     [bookmark: pgfId-1543221]
 
      
       
        
        [bookmark: pgfId-1543206]Table 32-8 Thresholding Instance/Time Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1543210]Option 
          
  
         	 
           
           [bookmark: pgfId-1543212]Description 
          
  
        
 
         
         	[bookmark: pgfId-1543214]Count
  
         	[bookmark: pgfId-1543216]The number of event instances per specified time period per tracking IP address required to meet the threshold.
  
        
 
         
         	[bookmark: pgfId-1543218]Seconds
  
         	[bookmark: pgfId-1543220]The number of seconds that elapse before the count resets. If you set the threshold type to limit, the tracking to Source IP, the count to 10, and the seconds to 10, the system logs and displays the first 10 events that occur in 10 seconds from a given source port. If only 7 events occur in the first 10 seconds, the system logs and displays those; if 40 events occur in the first 10 seconds, the system logs and displays 10, then begins counting again when the 10-second time period elapses.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1543222]Note that you can use intrusion event thresholding alone or in any combination with rate-based attack prevention, the detection_filter keyword, and intrusion event suppression. See Adding Dynamic Rule States, Filtering Events, and Configuring Suppression Per Intrusion Policy for more information.
 
     [bookmark: pgfId-1543232]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1543236]Adding and Modifying Intrusion Event Thresholds
 
      	 [bookmark: pgfId-1543240]Setting a Threshold for a Rule
 
      	 [bookmark: pgfId-1543244]Viewing and Deleting Intrusion Event Thresholds
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1543247]Tip You can also add thresholds from within the packet view of an intrusion event. See Viewing Event Information for more information.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1543435][bookmark: 98650]Adding and Modifying Intrusion Event Thr[bookmark: marker-1543434]esholds
 
     [bookmark: pgfId-1543442]License: Protection
 
     [bookmark: pgfId-1543444]You can set a threshold for one or more specific rules. You can also separately or simultaneously modify existing threshold settings. You can set a a single threshold for each. Adding a threshold overwrites any existing threshold for the rule.
 
     [bookmark: pgfId-1543447]For more information on viewing and deleting threshold configurations, see Viewing and Deleting Intrusion Event Thresholds.
 
     [bookmark: pgfId-1543449]You can also modify the global threshold that applies by default to all rules and preprocessor-generated events. For more information, see Globally Limiting Intrusion Event Logging.
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1543457]Tip A global or individual threshold on a managed device with multiple CPUs may result in a higher number of events than expected.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1543458]To add or modify event thresholds:
 
     [bookmark: pgfId-1543462]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1543463]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1543464]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1543469]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1543473]The Policy Information page appears.
 
     [bookmark: pgfId-1543540]Step 3 [bookmark: 28388]Click Rules.
 
     [bookmark: pgfId-1543541]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
     [bookmark: pgfId-1543542]Step 4 Locate the rule or rules where you want to set a threshold. You have the following options:
 
      
       
       	 [bookmark: pgfId-1543543]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1543544]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1543551]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1543552]Step 5 Select the rule or rules where you want to set a threshold. You have the following options:
 
      
       
       	 [bookmark: pgfId-1543553]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1543554]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1543555]Step 6 Select Event Filtering > Threshold.
 
     [bookmark: pgfId-1543556]The thresholding pop-up window appears.
 
     [bookmark: pgfId-1543651]Step 7 From the Type drop-down list, select the type of threshold you want to set:
 
      
       
       	 [bookmark: pgfId-1543652]Select  Limit to limit notification to the specified number of event instances per time period.
 
       	 [bookmark: pgfId-1543653]Select  Threshold to provide notification for each specified number of event instances per time period.
 
       	 [bookmark: pgfId-1543654]Select  Both to provide notification once per time period after a specified number of event instances.
 
      
 
     
 
     [bookmark: pgfId-1543655]Step 8 From the Track By drop-down list, select whether you want the event instances tracked by Source or Destination IP address.
 
     [bookmark: pgfId-1543656]Step 9 In the Count field, specify the number of event instances you want to use as your threshold.
 
     [bookmark: pgfId-1543657]Step 10 In the Seconds field, specify the number of seconds that make up the time period for which event instances are tracked.
 
     [bookmark: pgfId-1543658]Step 11 Click OK.
 ) next to the rule in the Event Filtering column. If you add multiple event filters to a rule, a number over the icon indicates the number of event filters. 
     
 
     [bookmark: pgfId-1543663]Step 12 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
     [bookmark: pgfId-1571675]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1543667]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1543839][bookmark: 55878]Viewi[bookmark: marker-1543838]ng and Deleting Intrusion Event Thresholds
 
     [bookmark: pgfId-1543846]License: Protection
 
     [bookmark: pgfId-1543847]You may want to view or delete an existing threshold setting. You can use the Rules Details view to display the configured settings for a threshold to see if they are appropriate for your system. If they are not, you can add a new threshold to overwrite the existing values.
 
     [bookmark: pgfId-1543848]Note that you can also modify the global threshold that applies by default to all rules and preprocessor-generated events. See Globally Limiting Intrusion Event Logging for more information.
 
     [bookmark: pgfId-1543852]To view or delete a threshold:
 
     [bookmark: pgfId-1543856]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1543857]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1543858]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1543906]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1543910]The Policy Information page appears.
 
     [bookmark: pgfId-1543912]Step 3 [bookmark: 27311]Click Rules.
 
     [bookmark: pgfId-1543913]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
     [bookmark: pgfId-1543914]Step 4 Locate the rule or rules that have a configured threshold you want to view or delete. You have the following options:
 
      
       
       	 [bookmark: pgfId-1543915]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1543916]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1543923]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1543924]Step 5 Select the rule or rules with a configured threshold you want to view or delete. You have the following options:
 
      
       
       	 [bookmark: pgfId-1543925]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1543926]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1543927]Step 6 To remove the threshold for each selected rule, select Event Filtering > Remove Thresholds. Click OK in the confirmation pop-up window that appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-1543928]Tip To remove a specific threshold, you can also highlight the rule and click Show details. Expand the threshold settings, then click Delete next to the threshold settings you want to remove. Click OK to confirm that you want to delete the configuration.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1543929]The page refreshes and the threshold is deleted.
 
     [bookmark: pgfId-1543930]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1543934]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1544051][bookmark: 74467]Configur[bookmark: marker-1544049]ing Suppression Per Intrusion Policy
 
     [bookmark: pgfId-1544059]License: Protection
 
     [bookmark: pgfId-1544060]You can suppress intrusion event notification when a specific IP address or range of IP addresses triggers a specific rule or preprocessor. This is useful for eliminating false positives. For example, if you have a mail server that transmits packets that look like a specific exploit, you might suppress event notification for that event when it is triggered by your mail server. The rule triggers for all packets, but you only see events for legitimate attacks.
 
     [bookmark: pgfId-1544061]Note that you can use intrusion event suppression alone or in any combination with rate-based attack prevention, the detection_filter keyword, and intrusion event thresholding. See Adding Dynamic Rule States, Filtering Events, and Configuring Event Thresholding for more information.
 
     [bookmark: pgfId-1544071]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1544075]Suppressing Intrusion Events
 
      	 [bookmark: pgfId-1544117]Viewing and Deleting Suppression Conditions
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1544120]Tip You can also add suppressions from within the packet view of an intrusion event. See Viewing Event Information for more information. You can also access suppression settings by using the right-click context menu on the Rule Editor page and on any intrusion event page (if the event was triggered by an intrusion rule).
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1544190][bookmark: 53032]Suppressing[bookmark: marker-1544188] Intrusion Events
 
     [bookmark: pgfId-1544197]License: Protection
 
     [bookmark: pgfId-1544199]You can suppress intrusion event notification for a rule or rules. When notification is suppressed for a rule, the rule triggers but events are not generated. You can set one or more suppressions for a rule. The first suppression listed has the highest priority. Note that when two suppressions conflict, the action of the first is carried out. 
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
     [bookmark: pgfId-1544204]To suppress event display:
 
     [bookmark: pgfId-1544208]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1544209]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1544210]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1544215]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1544219]The Policy Information page appears.
 
     [bookmark: pgfId-1544221]Step 3 [bookmark: 18582]Click Rules.
 
     [bookmark: pgfId-1544222]The Rules page appears. By default, the page lists the rules alphabetically by message. 
 
     [bookmark: pgfId-1544223]Step 4 Locate the rule or rules where you want to set suppression. You have the following options:
 
      
       
       	 [bookmark: pgfId-1544224]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1544225]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1544232]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1544337]Step 5 Select the rule or rules for which you want to configure suppression conditions. You have the following options:
 
      
       
       	 [bookmark: pgfId-1544338]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1544339]To select all rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1544340]Step 6 Select Event Filtering > Suppression.
 
     [bookmark: pgfId-1544341]The suppression pop-up window appears.
 
     [bookmark: pgfId-1544342]Step 7 Select one of the following Suppression Type options:
 
      
       
       	 [bookmark: pgfId-1544343]Select  Rule to completely suppress events for a selected rule.
 
       	 [bookmark: pgfId-1544344]Select  Source to suppress events generated by packets originating from a specified source IP address.
 
       	 [bookmark: pgfId-1544345]Select  Destination to suppress events generated by packets going to a specified destination IP address.
 
      
 
     
 
     [bookmark: pgfId-1544346]Step 8 If you selected Source or Destination for the suppression type, in the Network field enter the IP address, address block, or variable you want to specify as the source or destination IP address, or a comma-separated list comprised of any combination of these.
 
     [bookmark: pgfId-1544350]For information on using IPv4 CIDR and IPv6 prefix length address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1544432]Step 9 Click OK.
 ) next to the rule in the Event Filtering column next the suppressed rule. If you add multiple event filters to a rule, a number over the icon indicates the number of event filters. 
     
 
     [bookmark: pgfId-1544437]Step 10 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
     [bookmark: pgfId-1571686]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
    
 
     
      [bookmark: pgfId-1544654][bookmark: 85767]Viewing and De[bookmark: marker-1544653]leting Suppression Conditions
 
     [bookmark: pgfId-1544661]License: Protection
 
     [bookmark: pgfId-1544662]You may want to view or delete an existing suppression condition. For example, you can suppress event notification for packets originating from a mail server IP address because the mail server normally transmits packets that look like exploits. If you then decommission that mail server and reassign the IP address to another host, you should delete the suppression conditions for that source IP address.
 
     [bookmark: pgfId-1544663]To view or delete a defined suppression condition:
 
     [bookmark: pgfId-1544667]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1544668]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1544669]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1544674]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1544678]The Policy Information page appears.
 
     [bookmark: pgfId-1544680]Step 3 [bookmark: 19617]Click Rules.
 
     [bookmark: pgfId-1544681]The Rules page appears. By default, the page lists rules alphabetically by message. 
 
     [bookmark: pgfId-1544682]Step 4 Locate the rule or rules where you want to view or delete suppressions. You have the following options:
 
      
       
       	 [bookmark: pgfId-1544683]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1544684]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1544691]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1544759]Step 5 Select the rule or rules for which you want to view or delete suppressions. You have the following options:
 
      
       
       	 [bookmark: pgfId-1544760]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1544761]To select all rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1544762]Step 6 You have two options:
 
      
       
       	 [bookmark: pgfId-1544763]To remove all suppression for a rule, select  Event Filtering > Remove Suppressions.  Click  OK in the confirmation pop-up window that appears.
 
       	 [bookmark: pgfId-1544764]To remove a specific suppression setting, highlight the rule and click  Show details . Expand the suppression settings and click  Delete next to the suppression settings you want to remove. Click  OK to confirm that you want to delete your selected settings.
 
      
 
     
 
     [bookmark: pgfId-1544765]The page refreshes and the suppression settings are deleted.
 
     [bookmark: pgfId-1544766]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1544770]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1544882][bookmark: 76570]Adding Dynamic Rule State[bookmark: marker-1544880][bookmark: marker-1544881]s
 
    [bookmark: pgfId-1544890]License: Protection
 
    [bookmark: pgfId-1544891]Rate-based attacks attempt to overwhelm a network or host by sending excessive traffic toward the network or host, causing it to slow down or deny legitimate requests. You can use rate-based prevention to change the action of a rule in response to excessive rule matches for specific rules. 
 
    [bookmark: pgfId-1544892]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1544896]Understanding Dynamic Rule States
 
     	 [bookmark: pgfId-1544900]Setting a Dynamic Rule State
 
    
 
     
      [bookmark: pgfId-1544945][bookmark: 38940]Understanding Dynamic Rul[bookmark: marker-1544944]e States
 
     [bookmark: pgfId-1544952]License: Protection
 
     [bookmark: pgfId-1544953]You can configure your intrusion policies to include a rate-based filter that detects when too many matches for a rule occur in a given time period. You can use this feature on managed devices deployed inline to block rate-based attacks for a specified time, then revert to a rule state where rule matches only generate events and do not drop traffic. 
 
     [bookmark: pgfId-1544954]Rate-based attack prevention identifies abnormal traffic patterns and attempts to minimize the impact of that traffic on legitimate requests. You can identify excessive rule matches in traffic going to a particular destination IP address or addresses or coming from a particular source IP address or addresses. You can also respond to excessive matches for a particular rule across all detected traffic. 
 
     [bookmark: pgfId-1544955]In the intrusion policy, you can configure a rate-based filter for any intrusion or preprocessor rule. The rate-based filter contains three components: 
 
      
      	 [bookmark: pgfId-1544956]the rule matching rate, which you configure as a count of rule matches within a specific number of seconds
 
      	 [bookmark: pgfId-1544957]a new action to be taken when the rate is exceeded, with three available actions: Generate Events, Drop and Generate Events, and Disable
 
      	 [bookmark: pgfId-1544958]the duration of the action, which you configure as a timeout value
 
     
 
     [bookmark: pgfId-1544959]Note that when started, the new action occurs until the timeout is reached, even if the rate falls below the configured rate during that time period. When the timeout is reached, if the rate has fallen below the threshold, the action for the rule reverts to the action initially configured for the rule.
 
     [bookmark: pgfId-1545033]You can configure rate-based attack prevention in an inline deployment to block attacks, either temporarily or permanently. Without rate-based configuration, rules set to Generate Events do generate events, but the system does not drop packets for those rules. However, if the attack traffic matches rules that have rate-based criteria configured, the rate action may cause packet dropping to occur for the period of time that the rate action is active, even if those rules are not initially set to Drop and Generate Events. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1545034]Note Rate-based actions cannot enable disabled rules or drop traffic that matches disabled rules. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1545035]You can define multiple rate-based filters on the same rule. The first filter listed in the intrusion policy has the highest priority. Note that when two rate-based filter actions conflict, the action of the first rate-based filter is carried out. 
 
     [bookmark: pgfId-1545036]The following diagram shows an example where an attacker is attempting to access a host. Repeated attempts to find a password trigger a rule which has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events after rule matches occur five times in a 10-second span. The new rule attribute times out after 15 seconds. 
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1545116][bookmark: 46417]Setting a [bookmark: marker-1545115]Dynamic Rule State 
 
     [bookmark: pgfId-1545124]License: Protection
 
     [bookmark: pgfId-1545125]In some cases, you may not want to set a rule to the Drop and Generate Events state because you do not want to drop every packet that matches the rule, but you do want to drop packets matching the rule if a particular rate of matches occurs in a specified time. Dynamic rule states let you configure the rate that should trigger a change in the action for a rule, what the action should change to when the rate is met, and how long the new action should persist. 
 
     [bookmark: pgfId-1545126]You set the number of hits for that rule by specifying a count and the number of seconds within which that number of hits should occur to trigger the action change. In addition, you can set a timeout to cause the action to revert to the previous state for the rule when the timeout expires. 
 
     [bookmark: pgfId-1545127]You can define multiple dynamic rule state filters for the same rule. The first filter listed in the rule details in the intrusion policy has the highest priority. Note that when two rate-based filter actions conflict, the action of the first rate-based filter is carried out. 
 ) appears in a field when you type an invalid value; click it to revert to the last valid value for that field or to clear the field if there was no previous value. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1545132]Note Dynamic rule states cannot enable disabled rules or drop traffic that matches disabled rules. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1545414]To add a dynamic rule state:
 
     [bookmark: pgfId-1545418]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1545228]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1545229]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1545234]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1545238]The Policy Information page appears.
 
     [bookmark: pgfId-1545240]Step 3 [bookmark: 89579]Click Rules.
 
     [bookmark: pgfId-1545241]The Rules page appears.
 
     [bookmark: pgfId-1545242]Step 4 Locate the rule or rules where you want to add a dynamic rule state. You have the following options:
 
      
       
       	 [bookmark: pgfId-1545243]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
       	 [bookmark: pgfId-1545244]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
      
 
     
 
     [bookmark: pgfId-1545251]The page refreshes to display all matching rules.
 
     [bookmark: pgfId-1545252]Step 5 Select the rule or rules where you want to add a dynamic rule state. You have the following options:
 
      
       
       	 [bookmark: pgfId-1545253]To select a specific rule, select the check box next to the rule.
 
       	 [bookmark: pgfId-1545254]To select all the rules in the current list, select the check box at the top of the column.
 
      
 
     
 
     [bookmark: pgfId-1545255]Step 6 Select Dynamic State > Add Rate-Based Rule State. 
 
     [bookmark: pgfId-1545256]The Add Rate-Based Rule State dialog box appears.
 
     [bookmark: pgfId-1545257]Step 7 From the Track By drop-down list, select how you want the rule matches tracked: 
 
      
       
       	 [bookmark: pgfId-1545258]Select  Source to track the number of hits for that rule from a specific source or set of sources. 
 
       	 [bookmark: pgfId-1545259]Select  Destination to track the number of hits for that rule to a specific destination or set of destinations. 
 
       	 [bookmark: pgfId-1545260]Select  Rule to track all matches for that rule.
 
      
 
     
 
     [bookmark: pgfId-1545261]Step 8 If you set Track By to Source or Destination, enter the address of each host you want to track in the Network field.
 
     [bookmark: pgfId-1545262]You can specify a single IP address, address block, variable, or a comma-separated list comprised of any combination of these. For information on using IPv4 CIDR and IPv6 prefix length address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1545269]Step 9 Next to Rate, indicate the number of rule matches per time period to set the attack rate:
 
      
       
       	 [bookmark: pgfId-1545270]In the  Count field, using an integer between 1 and 2147483647, specify the number of rule matches you want to use as your threshold.
 
       	 [bookmark: pgfId-1545271]In the  Seconds field, using an integer between 1 and 2147483647, specify the number of seconds that make up the time period for which attacks are tracked.
 
      
 
     
 
     [bookmark: pgfId-1545272]Step 10 From the New State drop-down list, specify the new action to be taken when the conditions are met:
 
      
       
       	 [bookmark: pgfId-1545273]Select  Generate Events  to generate an event.
 
       	 [bookmark: pgfId-1545274]Select  Drop and Generate Events  to generate an event and drop the packet that triggered the event in inline deployments or generate an event in passive deployments.
 
       	 [bookmark: pgfId-1545275]Select  Disabled  to take no action.
 
      
 
     
 
     [bookmark: pgfId-1545276]Step 11 In the Timeout field, type the number of seconds you want the new action to remain in effect. After the timeout occurs, the rule reverts to its original state. Specify 0 or leave the Timeout field blank to prevent the new action from timing out. 
 
     [bookmark: pgfId-1545277]Step 12 Click OK.
 ) next to the rule in the Dynamic State column. If you add multiple dynamic rule state filters to a rule, a number over the icon indicates the number of filters. 
     
 
     [bookmark: pgfId-1545282]If any required fields are blank, you receive an error message indicating which fields you must fill.
 
      
       
     
 
     
 
     [bookmark: pgfId-1545283]Tip To delete all dynamic rule settings for a set of rules, select the rules on the Rules page, then select Dynamic State > Remove Rate-Based States. You can also delete individual rate-based rule state filters from the rule details for the rule by selecting the rule, clicking Show details, then clicking Delete by the rate-based filter you want to remove.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1545284]Step 13 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
     [bookmark: pgfId-1571703]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
     [bookmark: pgfId-1545288]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1545679][bookmark: 79224]Addi[bookmark: marker-1545678]ng SNMP Alerts
 
    [bookmark: pgfId-1545686]License: Protection
 
    [bookmark: pgfId-1560008]If you configure SNMP alerting for your FireSIGHT System, you can configure specific rules to provide an SNMP alert when the rule generates an event. For more information, see Using SNMP Responses.
 
    [bookmark: pgfId-1545750]To set an SNMP alert:
 
    [bookmark: pgfId-1545754]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1545755]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1545756]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1545761]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1545765]The Policy Information page appears.
 
    [bookmark: pgfId-1545767]Step 3 [bookmark: 50356]Click Rules.
 
    [bookmark: pgfId-1545768]The Rules page appears.
 
    [bookmark: pgfId-1545769]Step 4 Locate the rule or rules where you want to set SNMP alerts. You have the following options:
 
     
      
      	 [bookmark: pgfId-1545770]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
      	 [bookmark: pgfId-1545771]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
     
 
    
 
    [bookmark: pgfId-1545778]The page refreshes to display all matching rules.
 
    [bookmark: pgfId-1545779]Step 5 Select the rule or rules where you want to set SNMP alerts: 
 
     
      
      	 [bookmark: pgfId-1545780]To select a specific rule, select the check box next to the rule.
 
      	 [bookmark: pgfId-1545909]To select all the rules in the current list, select the check box at the top of the column.
 
     
 
    
 
    [bookmark: pgfId-1545989]Step 6 Select Alerting > Add SNMP Alert. 
 ) next to the rule in the Alerting column. If you add multiple alert types to a rule, a number over the icon indicates the number of alert types. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1545994]Tip To remove an SNMP alert from a rule, click the check box next to the rule and select Alerting > Remove SNMP Alerts, then click OK to confirm the deletion.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1545995]Step 7 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
    [bookmark: pgfId-1545999]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1546112][bookmark: 93855]Adding Rule Com[bookmark: marker-1546111]ments
 
    [bookmark: pgfId-1546119]License: Protection
 
    [bookmark: pgfId-1546121]You can add comments to a rule. Any comments you add can be seen in the Rule Details view on the Rules page. 
 
    [bookmark: pgfId-1546122]After you commit the intrusion policy changes containing the comment, you can also view the comment by clicking Rule Comment on the rule Edit page. For more information on editing rules, see Modifying Existing Rules.
 
    [bookmark: pgfId-1546126]To add a comment to a rule:
 
    [bookmark: pgfId-1546130]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1546131]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1546132]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1546137]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1546141]The Policy Information page appears.
 
    [bookmark: pgfId-1546143]Step 3 [bookmark: 31813]Click Rules.
 
    [bookmark: pgfId-1546144]The Rules page appears.
 
    [bookmark: pgfId-1546205]Step 4 Locate the rule or rules where you want to add a comment to a rule. You have the following options:
 
     
      
      	 [bookmark: pgfId-1546206]To sort the current display, click on a column heading or icon. To reverse the sort, click again.
 
      	 [bookmark: pgfId-1546207]Construct a filter by clicking on keywords or arguments in the filter panel on the left. For more information, see the following topics: Understanding Rule Filtering in an Intrusion Policy and Setting a Rule Filter in an Intrusion Policy.
 
     
 
    
 
    [bookmark: pgfId-1546214]The page refreshes to display all matching rules.
 
    [bookmark: pgfId-1546215]Step 5 Select the rule or rules where you want to add a comment: 
 
     
      
      	 [bookmark: pgfId-1546216]To select a specific rule, select the check box next to the rule.
 
      	 [bookmark: pgfId-1546217]To select all the rules in the current list, select the check box at the top of the column.
 
     
 
    
 
    [bookmark: pgfId-1546218]Step 6 Select Comments > Add Rule Comment.
 
    [bookmark: pgfId-1546219]The Add Comment dialog box appears.
 
    [bookmark: pgfId-1546220]Step 7 In the Comment field, type the rule comment.
 
    [bookmark: pgfId-1546250]Step 8 Click OK.
 ) next to the rule in the Comments column. If you add multiple comments to a rule, a number over the icon indicates the number of comments. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1546255]Tip To delete a rule comment, highlight the rule and click Show Details, then click Delete in the Comments section. Note that you can only delete a comment if the comment is cached with uncommitted intrusion policy changes. After intrusion policy changes are committed, the rule comment is permanent.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1546256]Step 9 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. 
 
    [bookmark: pgfId-1571722]See Managing Intrusion Policies and Editing Intrusion Policies for more information.
 
    [bookmark: pgfId-1533163]
 
     
     
 
    
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1532290][bookmark: 96930]Tailoring Intrusion Protection to Your Network Assets 
      
      
 
     
 
 
    [bookmark: pgfId-1532395]You can use the FireSIGHT Recommended Rules feature to associate the operating systems, servers, and client application protocols detected on your network (see Introduction to Network Discovery) with rules specifically written to protect those assets, per intrusion policy. This allows you to tailor your intrusion policy to the specific needs of your monitored network. The FireSIGHT Recommended Rules feature requires FireSIGHT and Protection licenses.
 
    [bookmark: pgfId-1532402]When you configure the FireSIGHT Recommended Rules feature, the system searches your base policy for rules that protect against vulnerabilities associated with your network assets, and identifies the current state of rules in your base policy. The system then recommends rule states and, optionally, sets the rules to the recommended states using the criteria in the following table.
 
    [bookmark: pgfId-1532440]
 
     
      
       
       [bookmark: pgfId-1532411]Table 33-1 FireSIGHT Rule State Recommendations Based on Vulnerabilities 
 
       
       
        
        	 
          
          [bookmark: pgfId-1532417]Base Policy Rule State 
         
  
        	 
          
          [bookmark: pgfId-1532419]Rule Protects Your Discovered Assets? 
         
  
        	 
          
          [bookmark: pgfId-1532421]Recommend Rule State 
         
  
       
 
        
        	[bookmark: pgfId-1532423]Generate Events or
Disable
  
        	[bookmark: pgfId-1532425]yes
  
        	[bookmark: pgfId-1532427]Generate Events
  
       
 
        
        	[bookmark: pgfId-1532429]Drop and Generate Events
  
        	[bookmark: pgfId-1532431]yes
  
        	[bookmark: pgfId-1532433]Drop and Generate Events
  
       
 
        
        	[bookmark: pgfId-1532435]any
  
        	[bookmark: pgfId-1532437]no
  
        	[bookmark: pgfId-1532439]Disable
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1532444]The Cisco Vulnerability Research Team (VRT) determines the appropriate state of each rule in the default policies provided by Cisco. Thus, when your base policy is a default policy provided by Cisco, the net effect of allowing the system to set your rules to the FireSIGHT recommended rule states is that the rules in your intrusion policy match the settings recommended by Cisco for your network assets. See Understanding the System-Provided Policies for more information.
 
    [bookmark: pgfId-1534378]Generating rule state recommendations can be as simple as choosing whether to use the recommended rule states, either when you generate recommendations or at a later time. Advanced recommendations options allow you to tailor your configuration further. Note that choosing to use recommended rule states adds a read-only FireSIGHT Recommendations layer to your intrusion policy, and subsequently choosing not to use recommended rule states removes the layer. See Using Layers in a Network Analysis or Intrusion Policy for information on using policy layers to more efficiently manage multiple intrusion policies.
 
    [bookmark: pgfId-1532466]Note that while the system typically recommends rule state changes for standard text rules and shared object rules, it can also recommend changes for preprocessor and decoder rules.
 
    [bookmark: pgfId-1532468]You can schedule a task to generate recommendations automatically based on the most recently saved configuration settings in your intrusion policy. For information on scheduling a task to generate recommended rule states, see Automating FireSIGHT Recommendations.
 
    [bookmark: pgfId-1532472]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1532476]Understanding Basic Rule State Recommendations
 
     	 [bookmark: pgfId-1532480]Understanding Advanced Rule State Recommendations
 
     	 [bookmark: pgfId-1532484]Using FireSIGHT Recommendations
 
    
 
   
 
    
     [bookmark: pgfId-1532487][bookmark: 56482]Understanding [bookmark: marker-1532486]Basic Rule State Recommendations
 
    [bookmark: pgfId-1532497]License: Protection + FireSIGHT
 
    [bookmark: pgfId-1532498]You can generate recommendations without using the recommended rule states in your policy. You can then display any of three filtered views of the Rules page to show rules that the system recommends you set to Generate Events, Drop and Generate Events, or Disable. This allows you to see beforehand which rules would be modified when you choose to use the recommended rule states. You can also choose to generate recommendations and immediately use them. 
 
    [bookmark: pgfId-1532499]While displaying the recommendation-filtered Rules page, or after accessing the Rules page directly from the navigation panel or the Policy Information page, you can manually set rule states, sort rules, and take any of the other actions available on the Rules page, such as suppressing rules, setting rule thresholds, and so on. See Setting Rule States for information on manually changing the state of selected rules. See Tuning Intrusion Policies Using Rules for information on other actions available on the Rules page for tailoring the rules in your intrusion policy.
 
    [bookmark: pgfId-1532506]The system does not change rule states that you set manually. When you choose to use the recommended rule states while generating recommendations:
 
     
     	 [bookmark: pgfId-1532507]manually setting the states of specified rules before you generate recommendations prevents the system from modifying the states of those rules in the future
 
     	 [bookmark: pgfId-1532508]manually setting the states of specified rules after you generate recommendations overrides the recommended states of those rules
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1532509]Tip You can include a list in the intrusion policy report of rules whose rule states differ from the recommended state. See Generating a Report of Current Intrusion Settings for more information.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1532520]Note also that when you generate recommendations without changing the advanced settings for FireSIGHT recommended rules, the system recommends rule state changes for all hosts in your entire discovered network. Note also that, by default, the system generates recommendations only for rules with low or medium overhead, and generates recommendations to disable rules. See Understanding Advanced Rule State Recommendations for more information.
 
   
 
    
     [bookmark: pgfId-1532529][bookmark: 57406]Understanding [bookmark: marker-1532528]Advanced Rule State Recommendations
 
    [bookmark: pgfId-1532542]License: Protection or Protection + FireSIGHT
 
    [bookmark: pgfId-1532543]Advanced settings allow you to redefine which hosts on your network the system monitors for vulnerabilities, to influence which rules the system recommends based on rule overhead, and to specify whether to generate recommendations to disable rules.
 
    [bookmark: pgfId-1532544]If you want to dynamically adapt active rule processing for specific packets based on host information, you can also enable adaptive profiles. For more information, see Adaptive Profiles and FireSIGHT Recommended Rules.
 
    [bookmark: pgfId-1532548]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1532552]Understanding the Networks to Examine
 
     	 [bookmark: pgfId-1532556]Understanding Rule Overhead
 
    
 
     
      [bookmark: pgfId-1532558][bookmark: 94433]Understanding the Networks to Examine
 
     [bookmark: pgfId-1532568]License: Protection + FireSIGHT
 
     [bookmark: pgfId-1532572]You configure the FireSIGHT Recommended Rules feature by identifying networks to examine in the network map. The system then recommends the rules you can activate to protect your network. For information on the network map, see Using the Network Map.
 
     [bookmark: pgfId-1532576]You configure the Networks field with the hosts to examine for recommendations. You can specify a single IP address or address block, or a comma-separated list comprised of either or both.
 
     [bookmark: pgfId-1532577]Lists of addresses within the hosts that you specify are linked with an OR operation except for negations, which are linked with an AND operation after all OR operations are calculated.
 
    
 
     
      [bookmark: pgfId-1532579][bookmark: 62698]Understanding Rule Overhead
 
     [bookmark: pgfId-1532586]License: Protection
 
     [bookmark: pgfId-1532590]Cisco rates the overhead of each intrusion rule as none, low, medium, or high, based on the rule’s potential impact on system performance and the likelihood that the rule may generate false positives. You can view the overhead rating for a rule in the rule detail view on the Rules page. See Viewing Rule Details for more information.
 
     [bookmark: pgfId-1532594]You can set the system to make rule state recommendations based on all rules up to and including a specified overhead rating. For example, when you generate recommendations for rules with medium overhead, the system makes recommendations based on all rules with an overhead rating of none, low, or medium, and does not make any recommendations for rules with high overhead.
 
     [bookmark: pgfId-1532595]Note that the system factors rule overhead into recommendations to generate events or to drop and generate events. The system does not factor rule overhead into recommendations to disable rules. Note also that local rules have no overhead, unless they are mapped to a third-party vulnerability. See Importing Local Rule Files and Managing Third-Party Product Mappings for more information.
 
     [bookmark: pgfId-1532602]Generating recommendations for rules with the overhead rating at a particular setting does not preclude you from generating recommendations with different overhead, then generating recommendations again for the original overhead setting. You get the same rule state recommendations for each overhead setting each time you generate recommendations for the same rule set, regardless of the number of times you generate recommendations or how many different overhead settings you generate with. For example, you can generate recommendations with overhead set to medium, then to high, then finally to medium again; if the hosts and applications on your network have not changed, both sets of recommendations with overhead set to medium are then the same for that rule set.
 
    
 
   
 
    
     [bookmark: pgfId-1532611][bookmark: 62364]Using FireSIGHT Re[bookmark: marker-1532608]commend[bookmark: marker-1532610]ations
 
    [bookmark: pgfId-1532622]License: FireSIGHT + Protection
 
    [bookmark: pgfId-1532623]You can generate recommendations with or without using the recommended rule states, and with or without modifying the advanced settings for generating recommendations. See Understanding Basic Rule State Recommendations and Understanding Advanced Rule State Recommendations for more information. 
 
    [bookmark: pgfId-1532630]After generating recommendations, you can use the recommended rule states; you can also view recommended states and use any features available on the Rules page. 
 
    [bookmark: pgfId-1532634]To use FireSIGHT rule state recommendations:
 
    [bookmark: pgfId-1532638]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1532639]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1532640]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1532645]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1532649]The Policy Information page appears.
 
    [bookmark: pgfId-1532650]Step 3 You have two options:
 
     
      
      	 [bookmark: pgfId-1532651]If you have not generated recommendations, select  No recommendations have been generated. Click here to set up   FireSIGHT  recommendations .
 
      	 [bookmark: pgfId-1532655]If you have generated recommendations, select  Click to change recommendations .
 
     
 
    
 
    [bookmark: pgfId-1532659]The FireSIGHT Recommended Rules Configuration page appears.
 
    [bookmark: pgfId-1532661]Step 4 [bookmark: 72701]You have the following choices:
 
     
      
      	 [bookmark: pgfId-1532662]To have the corresponding intrusion policy report list the rule message, recommended state, and actual state for all rules whose actual states differ from the recommended state, select Include all differences between recommendations and rule states in policy reports . See Generating a Report of Current Intrusion Settings for more information.
 
      	 [bookmark: pgfId-1532669]To generate recommendations using the default settings, go to step  9 .
 
      	 [bookmark: pgfId-1532673]To modify the advanced recommendations options, go to step  5 .
 
     
 
    
 section. 
    
 
    [bookmark: pgfId-1532682]The advanced FireSIGHT recommendations options appear.
 
    [bookmark: pgfId-1532683]Step 6 In the Networks field under Networks to Examine, specify the network to examine for recommendations.
 
    [bookmark: pgfId-1532689]For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
 
    [bookmark: pgfId-1532691]Note that lists of addresses are linked with an OR operation except for negations, which are linked with an AND operation after all OR operations are calculated. See Understanding the Networks to Examine for more information. 
 
    [bookmark: pgfId-1532695]Step 7 Optionally, under FireSIGHT Recommended Rules Configuration, drag the Recommendation Threshold (By Rule Overhead) slide bar to specify the amount of overhead a rule must have to be included in the recommendations you generate.
 
    [bookmark: pgfId-1532696]Dragging the slide bar to the right includes rules with higher overhead and will likely result in more recommendations, but may increasingly affect system performance. See Understanding Rule Overhead for more information.
 
    [bookmark: pgfId-1532700]Step 8 You have the following options:
 
     
      
      	 [bookmark: pgfId-1532701]To generate recommendations to disable rules, select the  Accept Recommendations to Disable Rules check box.
 
     
 
    
 
    [bookmark: pgfId-1532702]Note that accepting recommendations to disable rules restricts your rule coverage.
 
     
      
      	 [bookmark: pgfId-1532703]To prevent generating recommendations to disable rules, clear the  Accept Recommendations to Disable Rules check box.
 
     
 
    
 
    [bookmark: pgfId-1532704]Note that omitting recommendations to disable rules augments your rule coverage.
 
    [bookmark: pgfId-1532706]Step 9 [bookmark: 24280]You have several options:
 
     
      
      	 [bookmark: pgfId-1532707]Click  Generate and Use Recommendations if you have not yet generated recommendations and want the system to change your rule states automatically to the recommended states while generating recommendations. 
 
     
 
    
 
    [bookmark: pgfId-1532708]The system generates recommended rule state changes and automatically sets rules to the recommended states.
 
     
      
      	 [bookmark: pgfId-1532709]Click  Generate Recommendations if you want the system to generate recommendations without automatically changing your rule states to the recommended states. 
 
     
 
    
 
    [bookmark: pgfId-1532710]The system generates recommended rule state changes. 
 
     
      
      	 [bookmark: pgfId-1532711]If you have generated recommendations before, click  Update Recommendations to update existing recommendations. 
 
     
 
    
 
    [bookmark: pgfId-1532712]The system generates recommended rule state changes and, if recommendations are in use, automatically sets rules to the recommended states. The status updates for the number of recommendations, the number of hosts with recommended rule state changes, and the number of recommendations to generate events, drop and generate events, or disable rules.
 
     
      
      	 [bookmark: pgfId-1532713]If you have generated recommendations before, click  Use Recommendations to use recommendations that you have generated but have not used. 
 
     
 
    
 
    [bookmark: pgfId-1532714]The system automatically sets rules to the recommended states.
 
     
      
      	 [bookmark: pgfId-1532715]If you have generated and are already using recommendations, click  Do Not Use Recommendations to stop using recommendations currently in use. 
 
     
 
    
 
    [bookmark: pgfId-1532716]The system automatically resets rules to the default rule states unless a specific rule state was applied to the rule before using recommendations; in that case, the rule reverts to the specific rule state.
 
    [bookmark: pgfId-1532717]Note that the system does not recommend a rule state for an intrusion rule that is based on a vulnerability that you disable using the Impact Qualification feature. For more information, see Setting the Vulnerability Impact Qualification.
 
    [bookmark: pgfId-1532721]Note also that updating the policy to use or not use recommendations may take several minutes, depending on the size of your network and rule set.
 
     
      
    
 
    
 
    [bookmark: pgfId-1532722]Note The system always recommends that you enable a local rule associated with a third-party vulnerability mapped to a host. The system does not make state recommendations for unmapped local rules. For more information, see Managing Third-Party Product Mappings.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1532726]Step 10 Optionally, click View next to a recommendation type to display a recommendations-filtered view of the Rules page for the type of recommendation you selected.
 
    [bookmark: pgfId-1533992]Step 11 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1532846]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 74479]Detecting Specific Threats 
      
      
 
     
 
 
    [bookmark: pgfId-1573592]You can use several preprocessors in a network analysis policy to detect specific threats to your monitored network, such as Back Orifice attacks, several portscan types, and rate-based attacks that attempt to overwhelm your network with excessive traffic. Note that when an intrusion rule or rule argument requires a disabled preprocessor, the system automatically uses it with its current configuration even though it remains disabled in the network analysis policy’s web interface. For more information, see Limitations of Custom Policies.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1573973] 
     Caution Some users with custom user roles cannot access the network analysis policy via the standard menu path ( 
     Policies > Access Control > Network Analysis Policy). These users can access the network analysis policy through the intrusion policy: 
     Policies > Intrusion > Intrusion Policy > Network Analysis Policy. For more information on custom user roles, see 
     Managing Custom User Roles. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1565611]You can also use sensitive data detection, which you configure in an intrusion policy, to detect unsecured transmission of sensitive numerical data. 
 
    [bookmark: pgfId-1558057]See the following sections for more information on detecting specific threats:
 
     
     	 [bookmark: pgfId-1530810]Detecting Back Orifice explains detection of Back Orifice attacks.
 
     	 [bookmark: pgfId-1530814]Detecting Portscans describes the different types of portscans and explains how you can use portscan detection to identify threats to your networks before they develop into attacks.
 
     	 [bookmark: pgfId-1530818]Preventing Rate-Based Attacks explains how to limit denial of service (DoS) and SYN flood attacks.
 
     	 [bookmark: pgfId-1530822]Detecting Sensitive Data explains how to detect and generate events on sensitive data such as credit card numbers and Social Security numbers in ASCII text.
 
    
 
   
 
    
     [bookmark: pgfId-1530827][bookmark: 61750]Dete[bookmark: BackOrifice]cting Ba[bookmark: marker-1530826]ck Orifice
 
    [bookmark: pgfId-1536971]License: Protection
 
    [bookmark: pgfId-1536975]The FireSIGHT System provides a preprocessor that detects the existence of the Back Orifice program. This program can be used to gain admin access to your Windows hosts. The Back Orifice preprocessor analyzes [bookmark: marker-1536976]UDP traffic for the Back Orifice magic cookie, "*!*QWTY?", which is located in the first eight bytes of the packet and is XOR-encrypted.
 
    [bookmark: pgfId-1530838]The Back Orifice preprocessor has a configuration page, but no configuration options. When it is enabled, you must also enable the preprocessor rules in the following table for the preprocessor to generate corresponding events. See Setting Rule States for more information.
 
    [bookmark: pgfId-1530871]
 
     
      
       
       [bookmark: pgfId-1530848]Table 34-1 [bookmark: 68009]Back Orifice GID:SIDs 
 
       
       
        
        	 
          
          [bookmark: pgfId-1530852]Preprocessor rule GID:SID 
         
  
        	 
          
          [bookmark: pgfId-1530854]Description 
         
  
       
 
        
        	[bookmark: pgfId-1530856]105:1
  
        	[bookmark: pgfId-1530858]Back Orifice traffic detected
  
       
 
        
        	[bookmark: pgfId-1530860]105:2
  
        	[bookmark: pgfId-1530862]Back Orifice client traffic detected
  
       
 
        
        	[bookmark: pgfId-1530864]105:3
  
        	[bookmark: pgfId-1530866]Back Orifice server traffic detected
  
       
 
        
        	[bookmark: pgfId-1530868]105:4
  
        	[bookmark: pgfId-1530870]Back Orifice snort buffer attack detected
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1530872]To view the Back Orifice Detection page:
 
    [bookmark: pgfId-1530873]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1530874]Step 1 Select Policies > Access Control > Access Control Policy to display the Access Control Policy page, then click Network Analysis Policy.
 
    [bookmark: pgfId-1530875]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1530880]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1530884]The Policy Information page appears.
 
    [bookmark: pgfId-1530888]Step 3 In the navigation panel on the left, click Settings.
 
    [bookmark: pgfId-1565971]The Settings page appears.[bookmark: 43002]
 
    [bookmark: pgfId-1565916]Step 4 You have two choices, depending on whether Back Orifice Detection under Specific Threat Detection is enabled:
 
     
      
      	 [bookmark: pgfId-1530889]If the preprocessor is enabled, click  Edit .
 
      	 [bookmark: pgfId-1530890]If the preprocessor is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1530891]The Back Orifice Detection page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1562028]Step 5 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1551910]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1533130][bookmark: 91214]Detecting Por[bookmark: marker-1533129]tscans
 
    [bookmark: pgfId-1530912]License: Protection
 
    [bookmark: pgfId-1530913]A portscan is a form of network reconnaissance that is often used by attackers as a prelude to an attack. In a portscan, an attacker sends specially crafted packets to a targeted host. By examining the packets that the host responds with, the attacker can often determine which ports are open on the host and, either directly or by inference, which application protocols are running on these ports.
 
    [bookmark: pgfId-1530914]Note that when portscan detection is enabled, you must enable rules on the intrusion policy Rules page with generator ID (GID) 122 for enabled portscan types for the portscan detector to generate portscan events. See Setting Rule States and Table 34-5 for more information.
 
    [bookmark: pgfId-1530921]By itself, a portscan is not evidence of an attack. In fact, some of the portscanning techniques used by attackers can also be employed by legitimate users on your network. Cisco’s portscan detector is designed to help you determine which portscans might be malicious by detecting patterns of activity. 
 
     
      
       
       [bookmark: pgfId-1530932]Table 34-2 [bookmark: 89876]Protocol Types 
 
       
       
        
        	 
          
          [bookmark: pgfId-1530936]Protocol 
         
  
        	 
          
          [bookmark: pgfId-1530938]Description 
         
  
       
 
        
        	[bookmark: pgfId-1530940]TCP
  
        	[bookmark: pgfId-1530942]Detects TCP probes such as SYN scans, ACK scans, TCP connect() scans, and scans with unusual flag combinations such as Xmas tree, FIN, and NULL
  
       
 
        
        	[bookmark: pgfId-1530944]UDP
  
        	[bookmark: pgfId-1530946]Detects UDP probes such as zero-byte UDP packets
  
       
 
        
        	[bookmark: pgfId-1530948]ICMP
  
        	[bookmark: pgfId-1530950]Detects ICMP echo requests (pings)
  
       
 
        
        	[bookmark: pgfId-1530952]IP
  
        	[bookmark: pgfId-1530954]Detects IP protocol scans. These scans differ from TCP and UDP scans because the attacker, instead of looking for open ports, is trying to discover which IP protocols are supported on a target host.
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1530956]Note For events generated by the portscan connection detector, the protocol number is set to 255. Because portscan does not have a specific protocol associated with it by default, the Internet Assigned Numbers Authority (IANA) does not have a protocol number assigned to it. IANA designates 255 as a reserved number, so that number is used in portscan events to indicate that there is not an associated protocol for the event.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1561846]Table 34-3 [bookmark: 27486]Portscan Types 
 
       
       
        
        	 
          
          [bookmark: pgfId-1561850]Type 
         
  
        	 
          
          [bookmark: pgfId-1561852]Description 
         
  
       
 
        
        	[bookmark: pgfId-1561854]Portscan Detection
  
        	[bookmark: pgfId-1561856]A one-to-one portscan in which an attacker uses one or a few hosts to scan multiple ports on a single target host. 
 [bookmark: pgfId-1561857]One-to-one portscans are characterized by:
 
          
          	 [bookmark: pgfId-1561858]a low number of scanning hosts
 
          	 [bookmark: pgfId-1561859]a single host that is scanned
 
          	 [bookmark: pgfId-1561860]a high number of ports scanned
 
         
 [bookmark: pgfId-1561861]This option detects TCP, UDP, and IP portscans.
  
       
 
        
        	[bookmark: pgfId-1561863]Port Sweep
  
        	[bookmark: pgfId-1561866]A one-to-many [bookmark: marker-1561865]portsweep in which an attacker uses one or a few hosts to scan a single port on multiple target hosts.
 [bookmark: pgfId-1561867]Portsweeps are characterized by:
 
          
          	 [bookmark: pgfId-1561868]a low number of scanning hosts
 
          	 [bookmark: pgfId-1561869]a high number of scanned hosts
 
          	 [bookmark: pgfId-1561870]a low number of unique ports scanned
 
         
 [bookmark: pgfId-1561871]This option detects TCP, UDP, ICMP, and IP portsweeps.
  
       
 
        
        	[bookmark: pgfId-1561873]Decoy Portscan
  
        	[bookmark: pgfId-1561876]A one-to-one portscan in[bookmark: marker-1561875] which the attacker mixes spoofed source IP addresses with the actual scanning IP address.
 [bookmark: pgfId-1561877]Decoy portscans are characterized by:
 
          
          	 [bookmark: pgfId-1561878]a high number of scanning hosts
 
          	 [bookmark: pgfId-1561879]a low number of ports that are scanned only once
 
          	 [bookmark: pgfId-1561880]a single (or a low number of) scanned hosts
 
         
 [bookmark: pgfId-1561881]The decoy portscan option detects TCP, UDP, and IP protocol portscans.
  
       
 
        
        	[bookmark: pgfId-1561883]Distributed Portscan
  
        	[bookmark: pgfId-1561886]A many-to-one portscan in [bookmark: marker-1561885]which multiple hosts query a single host for open ports. 
 [bookmark: pgfId-1561887]Distributed portscans are characterized by:
 
          
          	 [bookmark: pgfId-1561888]a high number of scanning hosts
 
          	 [bookmark: pgfId-1561889]a high number of ports that are scanned only once
 
          	 [bookmark: pgfId-1561890]a single (or a low number of) scanned hosts
 
         
 [bookmark: pgfId-1561891]The distributed portscan option detects TCP, UDP, and IP protocol portscans.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531012]The information that the portscan detector learns about a probe is largely based on seeing negative responses from the probed hosts. For example, when a web client tries to connect to a web server, the client uses port 80/tcp and the server can be counted on to have that port open. However, when an attacker probes a server, the attacker does not know in advance if it offers web services. When the portscan detector sees a negative response (that is, an ICMP unreachable or TCP RST packet), it records the response as a potential portscan. The process is more difficult when the targeted host is on the other side of a device such as a firewall or router that filters negative responses. In this case, the portscan detector can generate filtered portscan events based on the sensitivity level that you select.
 
     
      
       
       [bookmark: pgfId-1561439]Table 34-4 [bookmark: 22132]Sensitivity Levels 
 
       
       
        
        	 
          
          [bookmark: pgfId-1561443]Level 
         
  
        	 
          
          [bookmark: pgfId-1561445]Description 
         
  
       
 
        
        	[bookmark: pgfId-1561447]Low
  
        	[bookmark: pgfId-1561449]Detects only negative responses from targeted hosts. Select this sensitivity level to suppress false positives, but keep in mind that some types of portscans (slow scans, filtered scans) might be missed.
 [bookmark: pgfId-1561450]This level uses the shortest time window for portscan detection.
  
       
 
        
        	[bookmark: pgfId-1561452]Medium
  
        	[bookmark: pgfId-1561454]Detects portscans based on the number of connections to a host, which means that you can detect filtered portscans. However, very active hosts such as network address translators and proxies may generate false positives. 
 [bookmark: pgfId-1561455]Note that you can add the IP addresses of these active hosts to the Ignore Scanned field to mitigate this type of false positive.
 [bookmark: pgfId-1561456]This level uses a longer time window for portscan detection.
  
       
 
        
        	[bookmark: pgfId-1561458]High
  
        	[bookmark: pgfId-1561460]Detects portscans based on a time window, which means that you can detect time-based portscans. However, if you use this option, you should be careful to tune the detector over time by specifying IP addresses in the Ignore Scanned and Ignore Scanner fields.
 [bookmark: pgfId-1561461]This level uses a much longer time window for portscan detection.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1531045]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531049]Configuring Portscan Detection
 
     	 [bookmark: pgfId-1531053]Understanding Portscan Events
 
    
 
     
      [bookmark: pgfId-1531058][bookmark: 93051]Confi[bookmark: marker-1531056]guring Por[bookmark: Portscan]tscan Detection
 
     [bookmark: pgfId-1531063]License: Protection
 
     [bookmark: pgfId-1531064]The portscan detection configuration options allow you to finely tune how the portscan detector reports scan activity.
 
     [bookmark: pgfId-1558623]Note that when portscan detection is enabled, you must enable rules on the Rules page with generator ID (GID) 122 for enabled portscan types for the portscan detector to generate portscan events. See Setting Rule States and the Portscan Detection SIDs (GID:122) table for more information.
 
     [bookmark: pgfId-1531072]To configure portscan detection:
 
     [bookmark: pgfId-1566068]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1566069]Step 1 Select Policies > Access Control > Access Control Policy to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1566117]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1531080]If you have unsaved changes in another policy, click OK to discard those changes and continue. See [was Committing Intrusion Policy Changes; update xref] for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1531084]The Policy Information page appears.
 
     [bookmark: pgfId-1566337]Step 3 In the navigation panel on the left, click Settings.
 
     [bookmark: pgfId-1566412]The Settings page appears.
 
     [bookmark: pgfId-1531087]Step 4 You have two choices, depending on whether Portscan Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1531088]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1531089]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1531090]The Portscan Detection page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1531094]Step 5 In the Protocol field, specify which of the following protocols you want to enable:
 
      
       
       	 [bookmark: pgfId-1531095]TCP
 
       	 [bookmark: pgfId-1531096]UDP
 
       	 [bookmark: pgfId-1531097]ICMP
 
       	 [bookmark: pgfId-1531098]IP
 
      
 
     
 
     [bookmark: pgfId-1531099]Use Ctrl or Shift while clicking to select multiple protocols or clear individual protocols. See the Protocol Types table for more information.
 
     [bookmark: pgfId-1531103]Note that you must ensure TCP stream processing is enabled to detect scans over TCP, and that UDP stream processing is enabled to detect scans over UDP. 
 
     [bookmark: pgfId-1531104]Step 6 In the Scan Type field, specify which of the following portscans you want to detect:
 
      
       
       	 [bookmark: pgfId-1531105]Portscan Detection 
 
       	 [bookmark: pgfId-1531106]Port Sweep
 
       	 [bookmark: pgfId-1531107]Decoy Portscan
 
       	 [bookmark: pgfId-1531108]Distributed Portscan
 
      
 
     
 
     [bookmark: pgfId-1531109]Use Ctrl or Shift while clicking to select or deselect multiple protocols. See the Portscan Types table for more information.
 
     [bookmark: pgfId-1531113]Step 7 In the Sensitivity Level list, select the level you want to use: low, medium, or high.
 
     [bookmark: pgfId-1531117]See the Sensitivity Levels table for more information.
 
     [bookmark: pgfId-1531118]Step 8 Optionally, in the Watch IP field, specify which host you want to watch for signs of portscan activity, or leave the field blank to watch all network traffic.
 
     [bookmark: pgfId-1531119]You can specify a single IP address or address block, or a comma-separated lists of either or both. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1531126]Step 9 Optionally, in the Ignore Scanners field, specify which hosts you want to ignore as scanners. Use this field to indicate hosts on your network that are especially active. You may need to modify this list of hosts over time.
 
     [bookmark: pgfId-1531127]You can specify a single IP address or address block, or a comma-separated lists of either or both. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1531134]Step 10 Optionally, in the Ignore Scanned field, specify which hosts you want to ignore as the target of a scan. Use this field to indicate hosts on your network that are especially active. You may need to modify this list of hosts over time.
 
     [bookmark: pgfId-1531135]You can specify a single IP address or address block, or a comma-separated lists of either or both. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1531142]Step 11 Optionally, clear the Detect Ack Scans check box to discontinue monitoring of sessions picked up in mid-stream. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1531143]Note Detection of mid-stream sessions helps to identify ACK scans, but may cause false events, particularly on networks with heavy traffic and dropped packets.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1562044]Step 12 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1551933]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1531161][bookmark: 91165]Understanding Portscan[bookmark: marker-1531160] Events
 
     [bookmark: pgfId-1531165]License: Protection
 
     [bookmark: pgfId-1531166]When portscan detection is enabled, you must enable rules with generator ID (GID) 122 and a Snort ID (SID) from among SIDs 1 through 27 to generate events for each enabled portscan type. See Setting Rule States for more information. The Preprocessor Rule SID column in the following table lists the SID for the preprocessor rule you must enable for each portscan type.
 
     [bookmark: pgfId-1531223]
 
      
       
        
        [bookmark: pgfId-1531176]Table 34-5 [bookmark: 48534]Portscan Detection SIDs (GID:122) 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531184]Portscan Type 
          
  
         	 
           
           [bookmark: pgfId-1531186]Protocol: 
          
  
         	 
           
           [bookmark: pgfId-1531188]Sensitivity Level 
          
  
         	 
           
           [bookmark: pgfId-1531190]Preprocessor Rule SID 
          
  
        
 
         
         	[bookmark: pgfId-1531192]Portscan Detection
  
         	[bookmark: pgfId-1531194]TCP 

UDP 

ICMP

IP
  
         	[bookmark: pgfId-1531196]Low
Medium or High
Low
Medium or High
Low
Medium or High
Low
Medium or High
  
         	[bookmark: pgfId-1531198]1
5
17
21
Does not generate events.
Does not generate events.
9
13
  
        
 
         
         	[bookmark: pgfId-1531200]Port Sweep
  
         	[bookmark: pgfId-1531202]TCP

UDP

ICMP

IP
  
         	[bookmark: pgfId-1531204]Low
Medium or High
Low
Medium or High
Low
Medium or High
Low
Medium or High
  
         	[bookmark: pgfId-1531206]3, 27
7
19
23
25
26
11
15
  
        
 
         
         	[bookmark: pgfId-1531208]Decoy Portscan
  
         	[bookmark: pgfId-1531210]TCP

UDP

ICMP

IP
  
         	[bookmark: pgfId-1531212]Low
Medium or High
Low
Medium or High
Low
Medium or High
Low
Medium or High
  
         	[bookmark: pgfId-1531214]2
6
18
22
Does not generate events.
Does not generate events.
10
14
  
        
 
         
         	[bookmark: pgfId-1531216]Distributed Portscan
  
         	[bookmark: pgfId-1531218]TCP

UDP

ICMP

IP
  
         	[bookmark: pgfId-1531220]Low
Medium or High
Low
Medium or High
Low
Medium or High
Low
Medium or High
  
         	[bookmark: pgfId-1531222]4
8
20
24
Does not generate events.
Does not generate events.
12
16
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1531224]When you enable the accompanying preprocessor rules, the portscan detector generates intrusion events that you can view just as you would any other intrusion event. However, the information presented on the packet view is different from the other types of intrusion events. This section describes the fields that appear on the packet view for a portscan event and how you can use that information to understand the types of probes that occur on your network.
 
     [bookmark: pgfId-1531225]Begin by using the intrusion event views to drill down to the packet view for a portscan event. You can follow the procedures in Working with Intrusion Events.
 
     [bookmark: pgfId-1531229]Note that you cannot download a portscan packet because single portscan events are based on multiple packets; however, the portscan packet view provides all usable packet information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1531230]Note For events generated by the portscan connection detector, the protocol number is set to 255. Because portscan does not have a specific protocol associated with it by default, the Internet Assigned Numbers Authority (IANA) does not have a protocol number assigned to it. IANA designates 255 as a reserved number, so that number is used in portscan events to indicate that there is not an associated protocol for the event.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1531239]Table 34-6 [bookmark: Portscan Packet View Information]Portscan Packet View 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531243]Information 
          
  
         	 
           
           [bookmark: pgfId-1531245]Description 
          
  
        
 
         
         	[bookmark: pgfId-1531247]Device
  
         	[bookmark: pgfId-1531249]The device that detected the event.
  
        
 
         
         	[bookmark: pgfId-1531251]Time
  
         	[bookmark: pgfId-1531253]The time when the event occurred.
  
        
 
         
         	[bookmark: pgfId-1531255]Message 
  
         	[bookmark: pgfId-1531257]The event message generated by the preprocessor.
  
        
 
         
         	[bookmark: pgfId-1531259]Source IP
  
         	[bookmark: pgfId-1531261]The IP address of the scanning host.
  
        
 
         
         	[bookmark: pgfId-1531263]Destination IP
  
         	[bookmark: pgfId-1531265]The IP address of the scanned host.
  
        
 
         
         	[bookmark: pgfId-1531267]Priority Count
  
         	[bookmark: pgfId-1531269]The number of negative responses (for example, TCP RSTs and ICMP unreachables) from the scanned host. The higher the number of negative responses, the higher the priority count.
  
        
 
         
         	[bookmark: pgfId-1531271]Connection Count
  
         	[bookmark: pgfId-1531273]The number of active connections on the hosts. This value is more accurate for connection-based scans such as TCP and IP.
  
        
 
         
         	[bookmark: pgfId-1531275]IP Count
  
         	[bookmark: pgfId-1531277]The number of times that the IP addresses that contact the scanned host changes. For example, if the first IP address is 10.1.1.1, the second IP is 10.1.1.2, and the third IP is 10.1.1.1, then the IP count is 3.
 [bookmark: pgfId-1531278]This number is less accurate for active hosts such as proxies and DNS servers.
  
        
 
         
         	[bookmark: pgfId-1531280]Scanner/Scanned IP Range
  
         	[bookmark: pgfId-1531282]The range of IP addresses for the scanned hosts or the scanning hosts, depending on the type of scan. For portsweeps, this field shows the IP range of scanned hosts. For portscans, this shows the IP range of the scanning hosts.
  
        
 
         
         	[bookmark: pgfId-1531284]Port/Proto Count
  
         	[bookmark: pgfId-1531286]For TCP and UDP portscans, the number of times that the port being scanned changes. For example, if the first port scanned is 80, the second port scanned is 8080, and the third port scanned is again 80, then the port count is 3.
 [bookmark: pgfId-1531287]For IP protocol portscans, the number of times that the protocol being used to connect to the scanned host changes.
  
        
 
         
         	[bookmark: pgfId-1531289]Port/Proto Range
  
         	[bookmark: pgfId-1531291]For TCP and UDP portscans, the range of the ports that were scanned.
 [bookmark: pgfId-1531292]For IP protocol portscans, the range of IP protocol numbers that were used to attempt to connect to the scanned host.
  
        
 
         
         	[bookmark: pgfId-1531294]Open Ports
  
         	[bookmark: pgfId-1531296]The TCP ports that were open on the scanned host. This field appears only when the portscan detects one or more open ports.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1531301]Preventing [bookmark: 17387]Rate-Base[bookmark: marker-1531299]d Attacks
 
    [bookmark: pgfId-1531306]License: Protection
 
    [bookmark: pgfId-1531307]Rate-based attacks are attacks that depend on frequency of connection or repeated attempts to perpetrate the attack. You can use rate-based detection criteria to detect a rate-based attack as it occurs and respond to it when it happens, then return to normal detection settings after it stops. For more information on configuring rate-based detection, see the following topics:
 
     
     	 [bookmark: pgfId-1531311]Understanding Rate-Based Attack Prevention
 
     	 [bookmark: pgfId-1531315]Rate-Based Attack Prevention and Other Filters
 
     	 [bookmark: pgfId-1531319]Configuring Rate-Based Attack Prevention
 
     	 [bookmark: pgfId-1531323]Understanding Dynamic Rule States
 
     	 [bookmark: pgfId-1531327]Setting a Dynamic Rule State
 
    
 
     
      [bookmark: pgfId-1531330][bookmark: 85295]Understanding Rate-Based [bookmark: marker-1531329]Attack Prevention
 
     [bookmark: pgfId-1531334]License: Protection
 
     [bookmark: pgfId-1531335]You can configure your network analysis policy to include rate-based filters that detect excessive activity directed at hosts on your network. You can use this feature on managed devices deployed in inline mode to block rate-based attacks for a specified time, then revert to only generating events and not drop traffic. 
 
     [bookmark: pgfId-1531336]Rate-based attack prevention identifies abnormal traffic patterns and attempts to minimize the impact of that traffic on legitimate requests. Rate-based attacks usually have one of the following characteristics:
 
      
      	 [bookmark: pgfId-1531337]any traffic containing excessive incomplete connections to hosts on the network, indicating a SYN flood attack
 
     
 
     [bookmark: pgfId-1531340]To configure SYN attack detection, see Preventing SYN Attacks.
 
      
      	 [bookmark: pgfId-1531342]any traffic containing excessive complete connections to hosts on the network, indicating a TCP/IP connection flood attack
 
     
 
     [bookmark: pgfId-1531345]To configure simultaneous connection detection, see Controlling Simultaneous Connections.
 
      
      	 [bookmark: pgfId-1531347]excessive rule matches in traffic going to a particular destination IP address or addresses or coming from a particular source IP address or addresses. 
 
     
 
     [bookmark: pgfId-1531350]To configure source or destination-based dynamic rule states, see Setting a Dynamic Rule State.
 
      
      	 [bookmark: pgfId-1531352]excessive matches for a particular rule across all traffic. 
 
     
 
     [bookmark: pgfId-1531355]To configure rule-based dynamic rule states, see Setting a Dynamic Rule State.
 
     [bookmark: pgfId-1531357]In a network analysis policy, you can either configure SYN flood or TCP/IP connection flood detection for the entire policy; in an intrusion policy, you can set rate-based filters for individual intrusion or preprocessor rules. Note that manually adding a rate-based filter to rules 135:1 and 135:2 has no effect. Rules with GID:135 use the client as the source value and the server as the destination value. See Preventing SYN Attacks and Controlling Simultaneous Connections for more information.
 
     [bookmark: pgfId-1531364]Each rate-based filter contains several components: 
 
      
      	 [bookmark: pgfId-1531365]for policy-wide or rule-based source or destination settings, the network address designation
 
      	 [bookmark: pgfId-1531366]the rule matching rate, which you configure as a count of rule matches within a specific number of seconds
 
      	 [bookmark: pgfId-1531367]a new action to be taken when the rate is exceeded
 
     
 
     [bookmark: pgfId-1531368]When you set a rate-based setting for the entire policy, the system generates events when it detects a rate-based attack, and optionally can drop the traffic in an inline deployment. When setting rate-based actions for individual rules, you have three available actions: Generate Events, Drop and Generate Events, and Disable.
 
      
      	 [bookmark: pgfId-1531369]the duration of the action, which you configure as a timeout value
 
     
 
     [bookmark: pgfId-1531370]Note that when started, the new action occurs until the timeout is reached, even if the rate falls below the configured rate during that time period. When the timeout period expires, if the rate has fallen below the threshold, the action for the rule reverts to the action initially configured for the rule. For policy-wide settings, the action reverts to the action of each rule the traffic matches or stops if it does not match any rules.
 
     [bookmark: pgfId-1531371]You can configure rate-based attack prevention in an inline deployment to block attacks, either temporarily or permanently. Without rate-based configuration, rules set to Generate Events create events, but the system does not drop packets for those rules. However, if the attack traffic matches rules that have rate-based criteria configured, the rate action may cause packet dropping to occur for the period of time that the rate action is active, even if those rules are not initially set to Drop and Generate Events. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1531372]Note Rate-based actions cannot enable disabled rules or drop traffic that matches disabled rules. However, if you set a rate-based filter at the policy level, you can generate events on or generate events on and drop traffic that contains an excessive number of SYN packets or SYN/ACK interactions within a designated time period.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1531373]You can define multiple rate-based filters on the same rule. The first filter listed in the intrusion policy has the highest priority. Note that when two rate-based filter actions conflict, the system implements the action of the first rate-based filter. Similarly, policy-wide rate-based filters override rate-based filters set on individual rules if the filters conflict. 
 
     [bookmark: pgfId-1531374]The following diagram shows an example where an attacker is attempting to access a host. Repeated attempts to find a password trigger a rule which has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events after rule matches occur five times in a 10-second span. The new rule attribute times out after 15 seconds. 
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1531387][bookmark: 25426]Preventing [bookmark: marker-1531385]SYN Attacks
 
     [bookmark: pgfId-1531391]License: Protection
 
     [bookmark: pgfId-1531393]The SYN attack prevention option helps you protect your network hosts against SYN floods. You can protect individual hosts or whole networks based on the number of packets seen over a period of time. If your device is deployed passively, you can generate events. If your device is placed inline, you can also drop the malicious packets. After the timeout period elapses, if the rate condition has stopped, the event generation and packet dropping stops.
 
     [bookmark: pgfId-1531394]For example, you could configure a setting to allow a maximum of 10 SYN packets from any one IP address, and block further connections from that IP address for 60 seconds.
 
     [bookmark: pgfId-1531395]Enabling this option also activates rule 135:1. Manually activating this rule has no effect. The rule state is always displayed as Disabled, and never changes. The rule generates events when this option is enabled and a defined rate condition is exceeded.
 
    
 
     
      [bookmark: pgfId-1531400][bookmark: 10682]Controlling Simultaneous Connection[bookmark: marker-1531398][bookmark: marker-1531399]s
 
     [bookmark: pgfId-1531404]License: Protection
 
     [bookmark: pgfId-1531406]You can also limit TCP/IP connections to or from hosts on your network to prevent denial of service (DoS) attacks or excessive activity by users. When the system detects the configured number of successful connections to or from a specified IP address or range of addresses, it generates events on additional connections. The rate-based event generation continues until the timeout period elapses without the rate condition occurring. In an inline deployment you can choose to drop packets until the rate condition times out.
 
     [bookmark: pgfId-1531407]For example, you could configure a setting to allow a maximum of 10 successful simultaneous connections from any one IP address, and block further connections from that IP address for 60 seconds.
 
     [bookmark: pgfId-1531408]Enabling this option also activates rule 135:2. Manually activating this rule has no effect. The rule state is always displayed as Disabled, and never changes. The rule generates events when this option is enabled and a defined rate condition is exceeded.
 
    
 
     
      [bookmark: pgfId-1531411][bookmark: 57013]Rate-Based Attack Pre[bookmark: marker-1531410]vention and Other Filters
 
     [bookmark: pgfId-1531415]License: Protection
 
     [bookmark: pgfId-1531416]The detection_filter keyword and the thresholding and suppression features provide other ways to filter either the traffic itself or the events that the system generates. You can use rate-based attack prevention alone or in any combination with thresholding, suppression, or the detection_filter keyword. 
 
     [bookmark: pgfId-1531417]See the following examples for more information:
 
      
      	 [bookmark: pgfId-1531421]Rate-Based Attack Prevention and Detection Filtering
 
      	 [bookmark: pgfId-1531425]Dynamic Rule States and Thresholding or Suppression
 
      	 [bookmark: pgfId-1531428]Policy-Wide Rate-Based Detection and Thresholding or Suppression
 
      	 [bookmark: pgfId-1531433]Rate-Based Detection with Multiple Filtering Methods
 
     
 
    
 
     
      [bookmark: pgfId-1531436][bookmark: 99237]Rate-Based [bookmark: marker-1531435]Attack Prevention and Detection Filtering
 
     [bookmark: pgfId-1531440]License: Protection
 
     [bookmark: pgfId-1531442]The detection_filter keywor[bookmark: marker-1531441]d prevents a rule from triggering until a threshold number of rule matches occur within a specified time. When a rule includes the detection_filter keyword, the system tracks the number of incoming packets matching the pattern in the rule per timeout period. The system can count hits for that rule from particular source or destination IP addresses. After the rate exceeds the rate in the rule, event notification for that rule begins. 
 
     [bookmark: pgfId-1531443]The following example shows an attacker attempting a brute-force login. Repeated attempts to find a password trigger a rule that also includes the detection_filter keyword, with a count set to 5. This rule has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events for 20 seconds when there are five hits on the rule in a 10-second span.
 
     [bookmark: pgfId-1531444]As shown in the diagram, the first five packets matching the rule do not generate events because the rule does not trigger until the rate exceeds the rate indicated by the detection_filter keyword. After the rule triggers, event notification begins, but the rate-based criteria do not trigger the new action of Drop and Generate Events until five more packets pass. 
 
     [bookmark: pgfId-1531445]After the rate-based criteria are met, events are generated and the packets are dropped until the rate-based timeout period expires and the rate falls below the threshold. After twenty seconds elapse, the rate-based action times out. After the timeout, note that packets are still dropped in the rate-based sampling period that follows. Because the sampled rate is above the threshold rate in the previous sampling period when the timeout happens, the rate-based action continues.
 
     [bookmark: pgfId-1584384]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531454]Note that although the example does not depict this, you can use the Drop and Generate Events rule state in combination with the detection_filter keyword to start dropping traffic when hits for the rule reach the specified rate. When deciding whether to configure rate-based settings for a rule, consider whether setting the rule to Drop and Generate Events and including the detection_filter keyword would achieve the same result, or whether you want to manage the rate and timeout settings in the intrusion policy. For more information, see Setting Rule States.
 
    
 
     
      [bookmark: pgfId-1531460][bookmark: 70325]Dynamic Rule States and Thresholding or Suppress[bookmark: marker-1531459]ion
 
     [bookmark: pgfId-1531464]License: Protection
 
     [bookmark: pgfId-1531465]You can use thresholding and suppression to reduce excessive events by limiting the number of event notifications for a rule or by suppressing notifications altogether for that rule. For more information on the available options for thresholding and suppression, see Configuring Event Thresholding and Configuring Suppression Per Intrusion Policy.
 
     [bookmark: pgfId-1531472]If you apply suppression to a rule, the system suppresses event notifications for that rule for all applicable IP addresses even if a rate-based action change occurs. However, the interaction between thresholding and rate-based criteria is more complex. 
 
     [bookmark: pgfId-1531473]The following example shows an attacker attempting a brute-force login. Repeated attempts to find a password trigger a rule that has rate-based attack prevention configured. The rate-based settings change the rule attribute to Drop and Generate Events for 15 seconds when there are five hits on the rule in 10 seconds. In addition, a limit threshold limits the number of events the rule can generate to 10 events in 23 seconds. 
 
     [bookmark: pgfId-1531474]As shown in the diagram, the rule generates events for the first five matching packets. After five packets, the rate-based criteria trigger the new action of Drop and Generate Events, and for the next five packets the rule generates events and the system drops the packet. After the tenth packet, the limit threshold has been reached, so for the remaining packets the system does not generate events but does drop the packets.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531484]Note that although it is not shown in this example, if a new action triggers because of rate-based criteria after a threshold has been reached, the system generates a single event to indicate the change in action. So, for example, when the limit threshold of 10 is reached and the system stops generating events and the action changes from Generate Events to Drop and Generate Events on the 14th packet, the system generates an eleventh event to indicate the change in action. 
 
    
 
     
      [bookmark: pgfId-1531489][bookmark: 14803]Policy-Wide Rate-Based Detection and [bookmark: marker-1531486]Thresholding or Sup[bookmark: marker-1531487][bookmark: marker-1531488]pression
 
     [bookmark: pgfId-1531493]License: Protection
 
     [bookmark: pgfId-1531494]You can use thresholding and suppression to reduce excessive events by limiting the number of event notifications for a source or destination or by suppressing notifications altogether for that rule. For more information on the available options for thresholding and suppression, see Configuring Global Thresholds, Configuring Event Thresholding, and Configuring Suppression Per Intrusion Policy.
 
     [bookmark: pgfId-1531504]If suppression is applied to a rule, event notifications for that rule for all applicable IP addresses are suppressed even if a rate-based action change occurs because of a policy-wide or rule-specific rate-based setting. However, the interaction between thresholding and rate-based criteria is more complex. 
 
     [bookmark: pgfId-1531505]The following example shows an attacker attempting denial of service (DoS) attacks on hosts in your network. Many simultaneous connections to hosts from the same sources trigger a policy-wide Control Simultaneous Connections setting. The setting generates events and drops malicious traffic when there are five connections from one source in 10 seconds. In addition, a global limit threshold limits the number of events any rule or setting can generate to 10 events in 20 seconds. 
 
     [bookmark: pgfId-1531506]As shown in the diagram, the policy-wide setting generates events for the first ten matching packets and drops the traffic. After the tenth packet, the limit threshold is reached, so for the remaining packets no events are generated but the packets are dropped.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1531516]Note that although it is not shown in this example, if a new action triggers because of rate-based criteria after a threshold has been reached, the system generates a single event to indicate the change in action. So, for example, if the limit threshold of 10 has been reached and the system stops generating events and the action changes to Drop and Generate events on the 14th packet, the system generates an eleventh event to indicate the change in action. 
 
    
 
     
      [bookmark: pgfId-1531519][bookmark: 65399]Rate-Based Detection with [bookmark: marker-1531518]Multiple Filtering Methods
 
     [bookmark: pgfId-1531523]License: Protection
 
     [bookmark: pgfId-1531524]You may encounter situations where the detection_filter keyword, thresholding or suppression, and rate-based criteria all apply to the same traffic. When you enable suppression for a rule, events are suppressed for the specified IP addresses even if a rate-based change occurs. 
 
     [bookmark: pgfId-1531525]The following example shows an attacker attempting a brute force login, and describes a case where a detection_filter keyword, rate-based filtering, and thresholding interact. Repeated attempts to find a password trigger a rule which includes the detection_filter keyword, with a count set to 5. This rule also has rate-based attack prevention settings that change the rule attribute to Drop and Generate Events for 30 seconds when there are five rule hits in 15 seconds. In addition, a limit threshold limits the rule to 10 events in 30 seconds. 
 
     [bookmark: pgfId-1531526]As shown in the diagram, the first five packets matching the rule do not cause event notification because the rule does not trigger until the rate indicated in the detection_filter keyword is exceeded. After the rule triggers, event notification begins, but the rate-based criteria do not trigger the new action of Drop and Generate Events until five more packets pass. After the rate-based criteria are met, the system generates events for packets 11-15 and drops the packets. After the fifteenth packet, the limit threshold has been reached, so for the remaining packets the system does not generate events but does drop the packets.
 
     [bookmark: pgfId-1531527]After the rate-based timeout, note that packets are still dropped in the rate-based sampling period that follows. Because the sampled rate is above the threshold rate in the previous sampling period, the new action continues. 
 
     [bookmark: pgfId-1584456]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-1531538][bookmark: 58910]Configuring Rate-Based Attack [bookmark: marker-1531537]Prevention
 
     [bookmark: pgfId-1531542]License: Protection
 
     [bookmark: pgfId-1531543]You can configure rate-based attack prevention at the policy level to stop SYN flood attacks. You can also stop excessive connections from a specific source or to a specific destination.
 
     [bookmark: pgfId-1531544]To configure rate-based attack prevention:
 
     [bookmark: pgfId-1531545]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1531546]Step 1 Select Policies > Access Control > Access Control Policy to display the Access Control Policy page, then click Network Analysis Policy.
 
     [bookmark: pgfId-1531547]The Network Analysis Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1531552]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1531556]The Policy Information page appears.
 
     [bookmark: pgfId-1566819]Step 3 In the navigation panel on the left, click Settings.
 
     [bookmark: pgfId-1566879]The Settings page appears.
 
     [bookmark: pgfId-1531559]Step 4 You have two choices, depending on whether Rate-Based Attack Prevention under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1531560]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1531561]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1531562]The Rate-Based Attack Prevention page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1531566]Step 5 You have two options:
 
      
       
       	 [bookmark: pgfId-1531567]To prevent incomplete connections intended to flood a host, click  Add under  SYN Attack Prevention .
 
      
 
     
 
     [bookmark: pgfId-1531568]The SYN Attack Prevention dialog box appears.
 
      
       
       	 [bookmark: pgfId-1531569]To prevent excessive numbers of connections, click  Add under  Control Simultaneous Connections .
 
      
 
     
 
     [bookmark: pgfId-1531570]The Control Simultaneous Connections dialog box appears.
 
     [bookmark: pgfId-1531571]Step 6 Select how you want to track traffic:
 
      
       
       	 [bookmark: pgfId-1531572]To track all traffic from a specific source or range of sources, select  Source from the  Track By drop-down list and type a single IP address or address block in the  Network field.
 
       	 [bookmark: pgfId-1531573]To track all traffic to a specific destination or range of destinations, select  Destination from the  Track By drop-down list and type an IP address or address block in the  Network field.
 
      
 
     
 
     [bookmark: pgfId-1531574]Note that the system tracks traffic separately for each IP address included in the Network field. Traffic from an IP address that exceeds the configured rate results in generated events only for that IP address. As an example, you might set a source CIDR block of 10.1.0.0/16 for the network setting and configure the system to generate events when there are ten simultaneous connections open. If eight connections are open from 10.1.4.21 and six from 10.1.5.10, the system does not generate events, because neither source has the triggering number of connections open. However, if eleven simultaneous connections are open from 10.1.4.21, the system generates events only for the connections from 10.1.4.21.
 
     [bookmark: pgfId-1531577]For information on using CIDR notation and prefix lengths in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1531582]Step 7 Indicate the triggering rate for the rate tracking setting:
 
      
       
       	 [bookmark: pgfId-1531583]For SYN attack configuration, indicate the number of SYN packets per number of seconds in the  Rate fields.
 
       	 [bookmark: pgfId-1531584]For simultaneous connection configuration, indicate the number of connections in the  Count field.
 
      
 
     
 
     [bookmark: pgfId-1531585]Step 8 To drop packets matching the rate-based attack prevention settings, select Drop. 
 
     [bookmark: pgfId-1531586]Step 9 In the Timeout field, indicate the time period after which to stop generating events, and if applicable, dropping, for traffic with the matching pattern of SYNs or simultaneous connections.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1531587] 
      Caution Timeout values can be integers from 1 to 1,000,000. However, setting a high timeout value may entirely block connection to a host in an inline deployment. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1561992]Step 10 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1551968]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1531594][bookmark: 26296]Detecting Se[bookmark: marker-1531593]nsitive Data
 
    [bookmark: pgfId-1531598]License: Protection
 
    [bookmark: pgfId-1531599]Sensitive data such as Social Security numbers, credit card numbers, driver’s license numbers, and so on may be leaked onto the Internet, intentionally or accidentally. The system provides a sensitive data preprocessor that can detect and generate events on sensitive data in ASCII text, which can be particularly useful in detecting accidental data leaks.
 
    [bookmark: pgfId-1531600]The system does not detect encrypted or obfuscated sensitive data, or sensitive data in a compressed or encoded format such as a Base64-encoded email attachment. For example, the system would detect the phone number (555)123-4567, but not an obfuscated version where each number is separated by spaces, as in (5 5 5) 1 2 3 - 4 5 6 7, or by intervening HTML code, such as <b>(555)</b>-<i>123-4567</i>. However, the system would detect, for example, the HTML coded number <b>(555)-123-4567</b> where no intervening codes interrupt the numbering pattern.
 
     
      
    
 
    
 
    [bookmark: pgfId-1531601]Tip The sensitive data preprocessor can detect sensitive data in unencrypted Microsoft Word files that are uploaded and downloaded using FTP or HTTP; this is possible because of the way Word files group ASCII text and formatting commands separately.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1566945]The system detects sensitive data per TCP session by matching individual data types against traffic. You can modify the default settings for each data type and for global options that apply to all data types in your intrusion policy. Cisco provides predefined, commonly used data types. You can also create custom data types.
 
    [bookmark: pgfId-1566949]A sensitive data preprocessor rule is associated with each data type. You enable sensitive data detection and event generation for each data type by enabling the corresponding preprocessor rule for the data type. A link on the configuration page takes you to a filtered view of sensitive data rules on the Rules page, where you can enable and disable rules and configure other rule attributes. 
 
    [bookmark: pgfId-1566976]When you save changes to your intrusion policy, you are given the option to automatically enable the sensitive data preprocessor if the rule associated with a data type is enabled and sensitive data detection is disabled.
 
    [bookmark: pgfId-1531614]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1531618]Deploying Sensitive Data Detection
 
     	 [bookmark: pgfId-1531622]Selecting Global Sensitive Data Detection Options
 
     	 [bookmark: pgfId-1531626]Selecting Individual Data Type Options
 
     	 [bookmark: pgfId-1531630]Using Predefined Data Types
 
     	 [bookmark: pgfId-1531634]Configuring Sensitive Data Detection
 
     	 [bookmark: pgfId-1531638]Selecting Application Protocols to Monitor
 
     	 [bookmark: pgfId-1531642]Special Case: Detecting Sensitive Data in FTP Traffic
 
     	 [bookmark: pgfId-1531646]Using Custom Data Types
 
    
 
     
      [bookmark: pgfId-1531649][bookmark: 23336]Deploying [bookmark: marker-1531648]Sensitive Data Detection
 
     [bookmark: pgfId-1531653]License: Protection
 
     [bookmark: pgfId-1531654]Because sensitive data detection can have a high impact on the performance of your FireSIGHT System, Cisco recommends that you adhere to the following guidelines:
 
      
      	 [bookmark: pgfId-1573108]Select the No Rules Active default policy as your base intrusion policy; see Understanding System-Provided Base Policies for more information.
 
      	 [bookmark: pgfId-1573110]Ensure that the following settings are enabled in the corresponding network analysis policy:
 
     
 
     [bookmark: pgfId-1573218] – FTP and Telnet Configuration under Application Layer Preprocessors
 
     [bookmark: pgfId-1573293] – IP Defragmentation and TCP Stream Configuration under Transport/Network Layer Preprocessors.
 
      
      	 [bookmark: pgfId-1573112]Apply the access control policy that includes the intrusion policy containing your sensitive data configuration to a separate device reserved for sensitive data detection; see Applying an Access Control Policy for more information.
 
     
 
    
 
     
      [bookmark: pgfId-1531675][bookmark: 68017]Selecting Global Se[bookmark: marker-1531674]nsitive Data Detection Options
 
     [bookmark: pgfId-1531679]License: Protection
 
     [bookmark: pgfId-1531680]Global sensitive data preprocessor options control how the preprocessor functions. You can modify global options that specify the following:
 
      
      	 [bookmark: pgfId-1531681]whether the preprocessor replaces all but the last four credit card or Social Security numbers in triggering packets
 
      	 [bookmark: pgfId-1531682]which destination hosts on your network to monitor for sensitive data
 
      	 [bookmark: pgfId-1531683]how many total occurrences of all data types in a single session result in an event
 
     
 
     [bookmark: pgfId-1531684]Note that global sensitive data options are policy-specific and apply to all data types.
 
     [bookmark: pgfId-1563035]You can configure the following global sensitive data detection options.
 
     [bookmark: pgfId-1563128][bookmark: 63470]Mask
 
     [bookmark: pgfId-1563130]Replaces with Xs all but the last four digits of credit card numbers and Social Security numbers in the triggering packet. The masked numbers appear in the intrusion event packet view in the web interface and in downloaded packets. See Using the Packet View for more information.
 
     [bookmark: pgfId-1563135]Networks
 
     [bookmark: pgfId-1563137]Specifies the destination host or hosts to monitor for sensitive data. You can specify a single IP address, address block, or a comma-separated list of either or both. The system interprets a blank field as any, meaning any destination IP address. For information on using IPv4 and IPv6 address blocks in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1563145]Global Threshold
 
     [bookmark: pgfId-1563147]Specifies the total number of all occurrences of all data types during a single session that the preprocessor must detect in any combination before generating a global threshold event. You can specify 1 through 65535.
 
     [bookmark: pgfId-1563151]Cisco recommends that you set the value for this option higher than the highest threshold value for any individual data type that you enable in your policy. See Selecting Individual Data Type Options for more information.
 
     [bookmark: pgfId-1563155]Note the following points regarding global thresholds:
 
     [bookmark: pgfId-1563156] – You must enable preprocessor rule 139:1 to detect and generate events on combined data type occurrences. See Setting Rule States for information on enabling rules in your intrusion policy.
 
     [bookmark: pgfId-1563160] – The preprocessor generates up to one global threshold event per session.
 
     [bookmark: pgfId-1563161] – Global threshold events are independent of individual data type events; that is, the preprocessor generates an event when the global threshold is reached, regardless of whether the event threshold for any individual data type has been reached, and vice versa.
 
    
 
     
      [bookmark: pgfId-1563087][bookmark: 45886]Selecting Individu[bookmark: marker-1563086]al Data Type Options
 
     [bookmark: pgfId-1531741]License: Protection
 
     [bookmark: pgfId-1531742]Individual data types identify the sensitive data you can detect and generate events on in your specified destination network traffic. You can modify default settings for data type options that specify the following:
 
      
      	 [bookmark: pgfId-1531743]a threshold that must be met for a detected data type to generate a single per-session event
 
      	 [bookmark: pgfId-1531744]the destination ports to monitor for each data type
 
      	 [bookmark: pgfId-1531745]the application protocols to monitor for each data type
 
     
 
     [bookmark: pgfId-1531746]At a minimum, each data type must specify an event threshold and at least one port or application protocol to monitor.
 
     [bookmark: pgfId-1531750]Each predefined data type provided by Cisco uses an otherwise inaccessible sd_pattern keyword to define a built-in data pattern to detect in traffic. See Table 34-8 for a listing of predefined data types. You can also create custom data types for which you use simple regular expressions to specify your own data patterns. See Using Custom Data Types for more information.
 
     [bookmark: pgfId-1531757]Note that data type names and patterns are system-wide; all other data type options are policy-specific.
 
     [bookmark: pgfId-1531758]The following table describes the data type options you can configure.
 
     [bookmark: pgfId-1531821]
 
      
       
        
        [bookmark: pgfId-1531765]Table 34-7 [bookmark: 62491]Individual Data Type Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531769]Option 
          
  
         	 
           
           [bookmark: pgfId-1531771]Description 
          
  
        
 
         
         	[bookmark: pgfId-1531773]Data Type
  
         	[bookmark: pgfId-1531775]Displays the unique name for the data type.
  
        
 
         
         	[bookmark: pgfId-1531777]Threshold
  
         	[bookmark: pgfId-1531779]Specifies the number of occurrences of the data type when the system generates an event. You receive an error message when you save the policy if you do not set a threshold for an enabled data type. You can specify 1 through 255.
 [bookmark: pgfId-1531780]Note that the preprocessor generates one event for a detected data type per session. Note also that global threshold events are independent of individual data type events; that is, the preprocessor generates an event when the data type event threshold is reached, regardless of whether the global event threshold has been reached, and vice versa.
  
        
 
         
         	[bookmark: pgfId-1531782]Destination Ports
  
         	[bookmark: pgfId-1531784]Specifies destination ports to monitor for the data type. You can specify a single port, a comma-separated list of ports, or any, meaning any destination port. You receive an error message when you save the policy if you enable the rule for a data type without setting at least one port or application protocol for the data type.
  
        
 
         
         	[bookmark: pgfId-1562646]Application Protocols
 [bookmark: pgfId-1531786]Note that this feature requires a Control license.
  
         	[bookmark: pgfId-1531795]Specifies up to eight application protocols to monitor for the data type. You receive an error message when you save the policy if you enable the rule for a data type without setting at least one port or application protocol for the data type.
 [bookmark: pgfId-1531798]At least one detector must be enabled (see Activating and Deactivating Detectors) for each application protocol you select. By default, all Cisco-provided detectors are activated. If no detector is enabled for an application protocol, the system automatically enables all Cisco-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.
 [bookmark: pgfId-1531809]See Selecting Application Protocols to Monitor for detailed instructions for selecting application protocols for data types.
  
        
 
         
         	[bookmark: pgfId-1531811]Pattern
  
         	[bookmark: pgfId-1531813]For a custom data type, the specified pattern to detect (data patterns for data types provided by Cisco are predefined). See Using Custom Data Types for more information. The web interface does not display built-in patterns for predefined data types.
 [bookmark: pgfId-1531820]Note that custom and predefined data patterns are system-wide.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1531824][bookmark: 75689]Using Predefined [bookmark: marker-1531823]Data Types
 
     [bookmark: pgfId-1531828]License: Protection
 
     [bookmark: pgfId-1531829]Each intrusion policy includes predefined data types for detecting commonly used data patterns such as credit card numbers, email addresses, U.S. phone numbers, and U.S. Social Security numbers with and without dashes. Each predefined data type is associated with a single sensitive data preprocessor rule that has a generator ID (GID) of 138. You must enable the associated sensitive data rule in the intrusion policy to enable detection, and event generation, for each data type you want to use in your policy. See Setting Rule States for information on enabling rules in an intrusion policy.
 
     [bookmark: pgfId-1531833]To help you enable sensitive data rules, a link on the configuration page takes you to a filtered view of the Rules page that displays all predefined and custom sensitive data rules. You can also display only predefined sensitive data rules by selecting the sensitive-data rule filtering category on the Rules page. See Filtering Rules in an Intrusion Policy for more information. Predefined sensitive data rules are also listed on the Rule Editor page (Policies > Intrusion > Rule Editor), where you can view but not edit them under the sensitive-data rule category.
 
     [bookmark: pgfId-1531837]The following table describes each data type and lists the corresponding preprocessor rule that you must enable to enable detection and event generation for the data type.
 
     [bookmark: pgfId-1531900]
 
      
       
        
        [bookmark: pgfId-1562556]Table 34-8 [bookmark: 72263]Sensitive Data Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-1562562]Data Type 
          
  
         	 
           
           [bookmark: pgfId-1562564]Description 
          
  
         	 
           
           [bookmark: pgfId-1562566]Preprocessor Rule GID:SID 
          
  
        
 
         
         	[bookmark: pgfId-1562568]Credit Card Numbers
  
         	[bookmark: pgfId-1562570]Matches Visa, MasterCard, Discover and American Express fifteen- and sixteen-digit credit card numbers, with or without their normal separating dashes or spaces; also uses the Luhn algorithm to verify credit card check digits.
  
         	[bookmark: pgfId-1562572]138:2
  
        
 
         
         	[bookmark: pgfId-1562574]Email Addresses
  
         	[bookmark: pgfId-1562576]Matches email addresses.
  
         	[bookmark: pgfId-1562578]138:5
  
        
 
         
         	[bookmark: pgfId-1562580]U.S. Phone Numbers
  
         	[bookmark: pgfId-1562582]Matches U.S. phone numbers adhering to the pattern (\d{3}) ?\d{3}-\d{4}.
  
         	[bookmark: pgfId-1562584]138:6
  
        
 
         
         	[bookmark: pgfId-1562586]U.S. Social Security Numbers Without Dashes
  
         	[bookmark: pgfId-1562588]Matches 9-digit U.S. Social Security numbers that have valid 3-digit area numbers, valid 2-digit group numbers, and do not have dashes.
  
         	[bookmark: pgfId-1562590]138:4
  
        
 
         
         	[bookmark: pgfId-1562592]U.S. Social Security Numbers With Dashes
  
         	[bookmark: pgfId-1562594]Matches 9-digit U.S. Social Security numbers that have valid 3-digit area numbers, valid 2-digit group numbers, and dashes.
  
         	[bookmark: pgfId-1562596]138:3
  
        
 
         
         	[bookmark: pgfId-1562604]Custom
  
         	[bookmark: pgfId-1562608]Matches a user-defined data pattern in the specified traffic. See Using Custom Data Types for more information.
  
         	[bookmark: pgfId-1562611]138:>999999
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1531901]To reduce false positives from 9-digit numbers other than Social Security numbers, the preprocessor uses an algorithm to validate the 3-digit area number and 2-digit group number that precede the 4-digit serial number in each Social Security number. The preprocessor validates Social Security group numbers through November 2009.
 
    
 
     
      [bookmark: pgfId-1531905][bookmark: 50107]Configuring Sensitiv[bookmark: marker-1531904]e Data Detection
 
     [bookmark: pgfId-1531910]License: Protection
 
     [bookmark: pgfId-1531911]You can modify default global settings and settings for individual data types. You must also enable the preprocessor rule for each data type you want to detect.
 
     [bookmark: pgfId-1531912]If you enable sensitive data preprocessor rules in your policy without enabling sensitive data detection, you are prompted to enable sensitive data detection when you save changes to your policy. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1531916]The following table describes actions you can take on the Sensitive Data Detection page.
 
     [bookmark: pgfId-1531994]
 
      
       
        
        [bookmark: pgfId-1531923]Table 34-9 [bookmark: 87329]Sensitive Data Configuration Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1531927]To... 
          
  
         	 
           
           [bookmark: pgfId-1531929]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1531931]modify global settings
  
         	[bookmark: pgfId-1531936]see Table 34-6 for information on the global settings you can modify.
  
        
 
         
         	[bookmark: pgfId-1531938]modify data type options
  
         	[bookmark: pgfId-1531940]click the data type name in the Targets page area.
 [bookmark: pgfId-1531941]The Configuration page area updates to display the current settings for the data type. See the Individual Data Type Options table for information on the options you can modify.
  
        
 
         
         	[bookmark: pgfId-1531946]add or remove application protocols to monitor for a data type
 [bookmark: pgfId-1531947]Note that this feature requires a Control license.
  
         	[bookmark: pgfId-1531955]click inside the Application Protocols field, or click Edit next to the field. The Application Protocols pop-up window appears:
 
           
           	 [bookmark: pgfId-1531956]To add up to eight application protocols to monitor, select one or more application protocols from the  Available list on the left, then click the right arrow ( > ) button.
 
           	 [bookmark: pgfId-1531957]To remove an application protocol, select it from the  Enabled list on the right, then click the left arrow ( < ) button.
 
          
 [bookmark: pgfId-1531958]Use Ctrl or Shift while clicking to select multiple application protocols. You can also click and drag to select multiple adjacent application protocols.
 [bookmark: pgfId-1572986]At least one detector must be enabled (see Activating and Deactivating Detectors) for each application protocol you select. By default, all Cisco-provided detectors are activated. If no detector is enabled for an application protocol, the system automatically enables all Cisco-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.
 application protocol. See Special Case: Detecting Sensitive Data in FTP Traffic for more information.
  
        
 
         
         	[bookmark: pgfId-1531974]create a custom data type
  
         	[bookmark: pgfId-1531976]click the + sign next to Data Types on the left side of the page. The Add Data Type pop-up window appears.
 [bookmark: pgfId-1531977]Specify a unique data type name and the pattern you want to detect with this data type and click OK, or click Cancel to abandon your edits. See Using Custom Data Types for more information.
  
        
 
         
         	[bookmark: pgfId-1531982]display sensitive data preprocessor rules 
  
         	[bookmark: pgfId-1531984]click the Configure Rules for Sensitive Data Detection link above the Global Settings page area. A listing of all sensitive data preprocessor rules appears in a filtered display of the Rules page.
 [bookmark: pgfId-1531985]Optionally, you can enable or disable any of the listed rules. Note that you must enable the sensitive data preprocessor rule for each data type that you want to use in your intrusion policy. See Setting Rule States for more information.
 [bookmark: pgfId-1531989]You can also configure sensitive data rules for any of the other actions available on the Rules page, such as rule suppression, rate-based attack prevention, and so on; see Tuning Intrusion Policies Using Rules for more information.
 [bookmark: pgfId-1531993]Click Back to return to the Sensitive Data Detection page.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1531995]To configure sensitive data detection:
 
     [bookmark: pgfId-1568578]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1568579]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1568580]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532003]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532007]The Policy Information page appears.
 
     [bookmark: pgfId-1532008]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532009]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532010]Step 4 You have two choices, depending on whether Sensitive Data Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1532011]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532012]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532013]The Sensitive Data Detection page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532019]Step 5 You can take any of the actions described in the Sensitive Data Configuration Actions table.
 
     [bookmark: pgfId-1562008]Step 6 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1551988]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532027][bookmark: 47428]Selecting Application Protocol[bookmark: marker-1532026]s to Monitor
 
     [bookmark: pgfId-1532031]License: Control
 
     [bookmark: pgfId-1532032]You can specify up to eight application protocols to monitor for each data type. See Working with Servers for more information on the application protocols the system can detect on your network.
 
     [bookmark: pgfId-1532038]At least one detector must be enabled (see Activating and Deactivating Detectors) for each application protocol you select. By default, all Cisco-provided detectors are activated. If no detector is enabled for an application protocol, the system automatically enables all Cisco-provided detectors for the application; if none exist, the system enables the most recently modified user-defined detector for the application.
 
     [bookmark: pgfId-1532046]You must specify at least one application protocol or port to monitor for each data type. However, except in the case where you want to detect sensitive data in FTP traffic, Cisco recommends for the most complete coverage that you specify corresponding ports when you specify application protocols. For example, if you specify HTTP, you might also configure the well-known HTTP port 80. If a new host on your network implements HTTP, the system will monitor port 80 during the interval when it is discovering the new HTTP application protocol. 
 
     [bookmark: pgfId-1532050]In the case where you want to detect sensitive data in FTP traffic, you must specify the FTP data application protocol; there is no advantage in specifying a port number. See Special Case: Detecting Sensitive Data in FTP Traffic for more information.
 
     [bookmark: pgfId-1532057]To modify application protocols to detect sensitive data:
 
     [bookmark: pgfId-1532058]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1532059]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1532060]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532065]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532069]The Policy Information page appears.
 
     [bookmark: pgfId-1532070]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532071]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532072]Step 4 You have two choices, depending on whether Sensitive Data Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1532073]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532074]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532075]The Sensitive Data Detection page appears.
 
     [bookmark: pgfId-1532076]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532080]Step 5 Click the data type name under Data Types to select the data type you want to modify.
 
     [bookmark: pgfId-1532081]The Configuration area updates to display the current settings for the selected data type.
 
     [bookmark: pgfId-1532082]Step 6 Click inside the Application Protocols field, or click Edit next to the field.
 
     [bookmark: pgfId-1532083]The Application Protocols pop-up window appears.
 
     [bookmark: pgfId-1532084]Step 7 You have two choices:
 
      
       
       	 [bookmark: pgfId-1532085]To add up to eight application protocols to monitor, select one or more application protocols from the  Available list on the left, then click the right arrow ( > ) button.
 
       	 [bookmark: pgfId-1532086]To remove an application protocol, select it from the  Enabled list on the right, then click the left arrow ( < ) button.
 
      
 
     
 
     [bookmark: pgfId-1532087]Use Ctrl or Shift while clicking to select multiple application protocols. You can also click and drag to select multiple adjacent application protocols.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532088]Note To detect sensitive data in FTP traffic, you must add the FTP data application protocol. See Special Case: Detecting Sensitive Data in FTP Traffic for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532092]Step 8 Click OK to add the application protocols.
 
     [bookmark: pgfId-1532093]The Sensitive Data Detection page is displayed and the application protocols are updated.
 
     [bookmark: pgfId-1552015]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532096][bookmark: 82297]Special Case: Detecting Sensitive [bookmark: marker-1532095]Data in FTP Traffic
 
     [bookmark: pgfId-1532100]License: Control
 
     [bookmark: pgfId-1532101]You usually determine which traffic to monitor for sensitive data by specifying the ports to monitor or, optionally, specifying application protocols in deployments. However, specifying ports or application protocols is not sufficient for detecting sensitive data in FTP traffic. Sensitive data in FTP traffic is found in traffic for the FTP application protocol, which occurs intermittently and uses a transient port number, making it difficult to detect. To detect sensitive data in FTP traffic, you must include the following in your configuration:
 
      
      	 [bookmark: pgfId-1532102]Specify the  FTP data application protocol.
 
     
 
     [bookmark: pgfId-1532103]Specifying the FTP data application protocol enables detection of sensitive data in FTP traffic. See Selecting Application Protocols to Monitor for more information.
 
     [bookmark: pgfId-1532108]In the special case of detecting sensitive data in FTP traffic, specifying the FTP data application protocol does not invoke detection; instead, it invokes the rapid processing of the FTP/Telnet processor to detect sensitive data in FTP traffic. See Decoding FTP and Telnet Traffic for more information.
 
      
      	 [bookmark: pgfId-1532117]Ensure that the FTP Data detector, which is enabled by default, is enabled. 
 
     
 
     [bookmark: pgfId-1532121]See Activating and Deactivating Detectors.
 
      
      	 [bookmark: pgfId-1532122]Ensure that your configuration includes at least one port to monitor for sensitive data. 
 
     
 
     [bookmark: pgfId-1532123]Note that it is not necessary to specify an FTP port except in the unlikely case where you only want to detect sensitive data in FTP traffic. Most sensitive data configurations will include other ports such as HTTP or email ports. In the case where you do want to specify only one FTP port and no other ports to monitor, Cisco recommends that you specify the FTP command port 23. See Configuring Sensitive Data Detection or more information.
 
    
 
     
      [bookmark: pgfId-1532132][bookmark: 29989]Using Custo[bookmark: marker-1532131]m Data Types
 
     [bookmark: pgfId-1532136]License: Protection
 
     [bookmark: pgfId-1532137]You can create and modify custom data types to detect data patterns that you specify. For example, a hospital might create a data type to protect patient numbers, or a university might create a data type to detect student numbers that have a unique numbering pattern.
 
     [bookmark: pgfId-1532138]Each custom date type you create also creates a single sensitive data preprocessor rule that has a generator ID (GID) of 138 and a Snort ID of 1000000 or greater, that is, a SID for a local rule. You must enable the associated sensitive data rule to enable detection, and event generation, for each custom data type you want to use in your policy. See Setting Rule States for information on enabling rules in an intrusion policy.
 
     [bookmark: pgfId-1532142]To help you enable sensitive data rules, a link on the configuration page takes you to a filtered view of the Rules page that displays all predefined and custom sensitive data rules. You can also display only custom sensitive data rules by selecting the local rule filtering category on the Rules page. See Filtering Rules in an Intrusion Policy for more information. Note that custom sensitive data rules are not listed on the Rule Editor page.
 
     [bookmark: pgfId-1532146]Custom data types you create are added to all intrusion policies. You must enable the associated sensitive data rule in any policy that you want to use to detect and generate events for a particular custom data type.
 
     [bookmark: pgfId-1532147]Note that you must use the Sensitive Data Detection configuration page to create data types and their associated rules. You cannot use the rule editor to create sensitive data rules.
 
     [bookmark: pgfId-1532148]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1532152]Defining Data Patterns in Custom Data Types
 
      	 [bookmark: pgfId-1532156]Configuring Custom Data Types
 
      	 [bookmark: pgfId-1532160]Editing Custom Data Type Names and Detection Patterns
 
     
 
    
 
     
      [bookmark: pgfId-1532162][bookmark: 47501]Defining Data Patterns in Custom Data Types
 
     [bookmark: pgfId-1532166]License: Protection
 
     [bookmark: pgfId-1532167]You define the data pattern for a custom data type using a simple set of regular expressions comprised of the following:
 
      
      	 [bookmark: pgfId-1532168]three metacharacters
 
      	 [bookmark: pgfId-1532169]escaped characters that allow you to use the metacharacters as literal characters
 
      	 [bookmark: pgfId-1532170]six character classes
 
     
 
     [bookmark: pgfId-1532171]Metacharacters are literal characters that have special meaning within regular expressions. The following table describes the metacharacters you can use when defining a custom data pattern.
 
     [bookmark: pgfId-1532210]
 
      
       
        
        [bookmark: pgfId-1532178]Table 34-10 [bookmark: 78237]Sensitive Data Pattern Metacharacters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532184]Metacharacter 
          
  
         	 
           
           [bookmark: pgfId-1532186]Description 
          
  
         	 
           
           [bookmark: pgfId-1532188]Example 
          
  
        
 
         
         	[bookmark: pgfId-1532190]?
  
         	[bookmark: pgfId-1532192]Matches zero or one occurrence of the preceding character or escape sequence; that is, the preceding character or escape sequence is optional.
  
         	[bookmark: pgfId-1532194]colou?r matches color or colour
  
        
 
         
         	[bookmark: pgfId-1532196]{n}
  
         	[bookmark: pgfId-1532198]Matches the preceding character or escape sequence n times.
  
         	[bookmark: pgfId-1532200]For example,
\d{2} matches 55, 12, and so on;
\l{3} matches AbC, www, and so on;
\w{3} matches a1B, 25C, and so on; 
x{5} matches xxxxx
  
        
 
         
         	[bookmark: pgfId-1532202]\
  
         	[bookmark: pgfId-1532204]Allows you to use metacharacters as actual characters and is also used to specify a predefined character class. See Table 34-12 for a description of the character classes you can use in sensitive data patterns.
  
         	[bookmark: pgfId-1532209]\? matches a question mark,
\\ matches a backslash, 
\d matches numeric characters, and so on
  
        
 
        
      
 
     
 
      
       
        
        [bookmark: pgfId-1532218]Table 34-11 [bookmark: 24764]Escaped Sensitive Data Pattern Characters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532222]Use this escaped character... 
          
  
         	 
           
           [bookmark: pgfId-1532224]To represent this literal character... 
          
  
        
 
         
         	[bookmark: pgfId-1532226]\?
  
         	[bookmark: pgfId-1532228]?
  
        
 
         
         	[bookmark: pgfId-1532230]\{
  
         	[bookmark: pgfId-1532232]{
  
        
 
         
         	[bookmark: pgfId-1532234]\}
  
         	[bookmark: pgfId-1532236]}
  
        
 
         
         	[bookmark: pgfId-1532238]\\
  
         	[bookmark: pgfId-1532240]\
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532242]The following table describes the character classes you can use when defining a custom sensitive data pattern.
 
     [bookmark: pgfId-1532297]
 
      
       
        
        [bookmark: pgfId-1532249]Table 34-12 [bookmark: 65810]Sensitive Data Pattern Character Classes 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532255]Character Class 
          
  
         	 
           
           [bookmark: pgfId-1532257]Description 
          
  
         	 
           
           [bookmark: pgfId-1532259]Character Class Definition 
          
  
        
 
         
         	[bookmark: pgfId-1532261]\d
  
         	[bookmark: pgfId-1532263]Matches any numeric ASCII character 0-9
  
         	[bookmark: pgfId-1532265]0-9
  
        
 
         
         	[bookmark: pgfId-1532267]\D
  
         	[bookmark: pgfId-1532269]Matches any byte that is not a numeric ASCII character
  
         	[bookmark: pgfId-1532271]not 0-9
  
        
 
         
         	[bookmark: pgfId-1532273]\l (lowercase “ell”)
  
         	[bookmark: pgfId-1532275]Matches any ASCII letter
  
         	[bookmark: pgfId-1532277]a-zA-Z
  
        
 
         
         	[bookmark: pgfId-1532279]\L
  
         	[bookmark: pgfId-1532281]Matches any byte that is not an ASCII letter
  
         	[bookmark: pgfId-1532283]not a-zA-Z
  
        
 
         
         	[bookmark: pgfId-1532285]\w
  
         	[bookmark: pgfId-1532287]Matches any ASCII alphanumeric character
 [bookmark: pgfId-1532288]Note that, unlike PCRE regular expressions, this does not include an underscore (_).
  
         	[bookmark: pgfId-1532290]a-zA-Z0-9
  
        
 
         
         	[bookmark: pgfId-1532292]\W
  
         	[bookmark: pgfId-1532294]Matches any byte that is not an ASCII alphanumeric character
  
         	[bookmark: pgfId-1532296]not a-zA-Z0-9
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532298]The preprocessor treats characters entered directly, instead of as part of a regular expression, as literal characters. For example, the data pattern 1234 matches 1234.
 
     [bookmark: pgfId-1532299]The following data pattern example, which is used in predefined sensitive data rule 138:4, uses the escaped digits character class, the multiplier and option-specifier metacharacters, and the literal dash (-) and left and right parentheses () characters to detect U.S. phone numbers:
 
      
      [bookmark: pgfId-1532300](\d{3}) ?\d{3}-\d{4} 
     
 
     [bookmark: pgfId-1532301]Exercise caution when creating custom data patterns. Consider the following alternative data pattern for detecting phone numbers which, although using valid syntax, could cause many false positives:
 
      
      [bookmark: pgfId-1532302](?\d{3})? ?\d{3}-?\d{4} 
     
 
     [bookmark: pgfId-1532303]Because the second example combines optional parentheses, optional spaces, and optional dashes, it would detect, among others, phone numbers in the following desirable patterns:
 
      
      	 [bookmark: pgfId-1532304] (555)123-4567 
 
      	 [bookmark: pgfId-1532305] 555123-4567 
 
      	 [bookmark: pgfId-1532306] 5551234567 
 
     
 
     [bookmark: pgfId-1532307]However, the second example pattern would also detect, among others, the following potentially invalid patterns, resulting in false positives:
 
      
      	 [bookmark: pgfId-1532308] (555 1234567 
 
      	 [bookmark: pgfId-1532309] 555)123-4567 
 
      	 [bookmark: pgfId-1532310] 555) 123-4567 
 
     
 
     [bookmark: pgfId-1532311]Consider finally, for illustration purposes only, an extreme example in which you create a data pattern that detects the lowercase letter a using a low event threshold in all destination traffic on a small company network. Such a data pattern could overwhelm your system with literally millions of events in only a few minutes.
 
    
 
     
      [bookmark: pgfId-1532314][bookmark: 59648]Configuring Cus[bookmark: marker-1532313]tom Data Types
 
     [bookmark: pgfId-1532318]License: Protection
 
     [bookmark: pgfId-1532319]You configure essentially the same data type options for custom data types that you configure for predefined data types. See Selecting Individual Data Type Options for information on setting options that are common to all data types. In addition, you must also specify the name and data pattern for custom data types.
 
     [bookmark: pgfId-1532323]Note that creating a custom data type also creates an associated custom sensitive data preprocessing rule, which you must enable in each policy where you want to use that data type. See Setting Rule States for information on enabling rules in your intrusion policy.
 
     [bookmark: pgfId-1532327]To create or modify a custom data type:
 
     [bookmark: pgfId-1532328]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1532329]Step 1 Select Policies> Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1532330]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532335]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532339]The Policy Information page appears.
 
     [bookmark: pgfId-1532340]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532341]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532342]Step 4 You have two choices, depending on whether Sensitive Data Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1532343]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532344]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532345]The Sensitive Data Detection page appears.
 
     [bookmark: pgfId-1532346]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532350]Step 5 You have the following options:
 
      
       
       	 [bookmark: pgfId-1532351]To create a custom data type, click the  + sign next to  Data Types on the left side of the page. The Add Data Type pop-up window appears.
 
      
 
     
 
     [bookmark: pgfId-1532352]Specify a unique data type name and the pattern you want to detect with this data type and click OK, or click Cancel to abandon your edits. See Editing Custom Data Type Names and Detection Patterns for more information.
 
     [bookmark: pgfId-1532356]The Sensitive Data Detection page appears. If you clicked OK, the page updates to display your changes.
 
      
       
       	 [bookmark: pgfId-1532357]To modify any of the options that are common to predefined and custom data types, click the data type name in the  Targets page area.
 
      
 
     
 
     [bookmark: pgfId-1532358]The Configuration page area updates to display the current settings for the data type. See Configuring Sensitive Data Detection for more information.
 
      
       
       	 [bookmark: pgfId-1532362]To edit the system-wide name and data pattern for a custom data type, see Editing Custom Data Type Names and Detection Patterns.
 
       	 [bookmark: pgfId-1532369]To delete a custom data type, click the delete icon (
 
      
 
      [image: ] ) next to the data type you want to remove and then click 
       OK , or click 
       Cancel to abandon deleting the data type. 
     
 
     [bookmark: pgfId-1532370]Note that you cannot delete a data type when the sensitive data rule for that data type is enabled in any intrusion policy. Deleting a custom data type deletes it from all intrusion policies.
 
     [bookmark: pgfId-1552045]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532372][bookmark: 32981]Editing Custom Data Type Names and Detection Patterns
 
     [bookmark: pgfId-1532376]License: Protection
 
     [bookmark: pgfId-1532377]You can modify the system-wide name and detection pattern for custom sensitive data rules. Note that changing these settings changes them in all other policies on the system. Note also that you must reapply any applied access control policies that include intrusion policies that use custom data types that you modify.
 
     [bookmark: pgfId-1532378]Except for custom data type names and data patterns, all data type options are policy-specific for both custom and predefined data types. See Selecting Individual Data Type Options for information on modifying options other than the name and data pattern in your custom data types.
 
     [bookmark: pgfId-1532382]To edit custom data type names and data patterns:
 
     [bookmark: pgfId-1532383]Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1532384]Step 1 Select Policies> Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1532385]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532390]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532394]The Policy Information page appears.
 
     [bookmark: pgfId-1532395]Step 3 Click Advanced Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532396]The Advanced Settings page appears.
 
     [bookmark: pgfId-1532397]Step 4 You have two choices, depending on whether Sensitive Data Detection under Specific Threat Detection is enabled:
 
      
       
       	 [bookmark: pgfId-1532398]If the configuration is enabled, click  Edit .
 
       	 [bookmark: pgfId-1532399]If the configuration is disabled, click  Enabled , then click  Edit .
 
      
 
     
 
     [bookmark: pgfId-1532400]The Sensitive Data Detection page appears.
 
     [bookmark: pgfId-1532401]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
     [bookmark: pgfId-1532405]Step 5 In the Targets page area, click the name of the custom data type you want to modify.
 
     [bookmark: pgfId-1532406]The page updates to show the current settings for the data type, and the Edit Data Type Name and Pattern link appears in the upper right of the Configuration page area.
 
     [bookmark: pgfId-1532407]Step 6 Click the Edit Data Type Name and Pattern link.
 
     [bookmark: pgfId-1532408]The Edit Data Type pop-up window appears.
 
     [bookmark: pgfId-1532409]Step 7 Modify the data type name, pattern, or both and click OK, or click Cancel to abandon your edits. See Defining Data Patterns in Custom Data Types for information on specifying the data pattern.
 
     [bookmark: pgfId-1532413]The Sensitive Data Detection page appears. If you clicked OK, the page displays your changes.
 
     [bookmark: pgfId-1552065]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532414]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1531506][bookmark: 60568]Globally Limiting Intr[bookmark: marker-1534486]usion Event Lo[bookmark: marker-1534504]gging 
      
      
 
     
 
 
    [bookmark: pgfId-1532030]You can use thresholds to limit the number of times the system logs and displays intrusion events. Thresholds, which you configure as part of your intrusion policy, cause the system to generate events based on how many times traffic matching a rule originates from or is targeted to a specific address or address range within a specified time period. This can prevent you from being overwhelmed with a large number of events. This feature requires a Protection license.
 
    [bookmark: pgfId-1532032]You can set event notification thresholds in two ways:
 
     
     	 [bookmark: pgfId-1532033]You can set a global threshold across all traffic to limit how often events from a specific source or destination are logged and displayed per specified time period. For more information, see Understanding Thresholding and Configuring Global Thresholds.
 
     	 [bookmark: pgfId-1532046]You can set thresholds per shared object rule, standard text rule, or preprocessor rule in your intrusion policy configuration, as described in Configuring Event Thresholding. 
 
    
 
   
 
    
     [bookmark: pgfId-1532051][bookmark: 22194]Understanding Thresholding
 
    [bookmark: pgfId-1532058]License: Protection
 
    [bookmark: pgfId-1532059]By default, every intrusion policy contains a global rule threshold. The default threshold limits event generation for each rule to one event every 60 seconds on traffic going to the same destination. This global [bookmark: marker-1532060]threshold applies by default to all intrusion rules and preprocessor rules. Note that you can disable the threshold in the Advanced Settings page in an intrusion policy. 
 
    [bookmark: pgfId-1532061]You can also override this threshold by setting individual thresholds on specific rules. For example, you might set a global limit threshold of five events every 60 seconds, but then set a specific threshold of ten events for every 60 seconds for SID 1315. All other rules generate no more than five events in each 60-second period, but the system generates up to ten events for each 60-second period for SID 1315.
 
    [bookmark: pgfId-1532065]For more information on setting rule-based thresholds, see Configuring Event Thresholding.
 
     
      
    
 
    
 
    [bookmark: pgfId-1532066]Tip A global or individual threshold on a managed device with multiple CPUs may result in a higher number of events than expected.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1532067]The following diagram shows an example where an attack is in progress for a specific rule. A global limit threshold limits event generation for each rule to two events every 20 seconds. 
 
    [bookmark: pgfId-1532068]Note that the period starts at one second and ends at 21 seconds. After the period ends, note that the cycle starts again and the next two rule matches generate events, then the system does not generate any more events during that period.
 
    [bookmark: pgfId-1537814]
 
     
     [image: ] 
    
 
     
      [bookmark: pgfId-1532077]Understanding Thresholding Options
 
     [bookmark: pgfId-1532084]License: Protection
 
     [bookmark: pgfId-1532085]Thresholding allows you to limit intrusion event generation by generating only a specific number of events in a time period, or by generating one event for a set of events. When you configure global thresholding, you must first specify the thresholding type, as described in the following table.
 
     [bookmark: pgfId-1532113]
 
      
       
        
        [bookmark: pgfId-1532091]Table 35-1 [bookmark: 82757]Thresholding Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532095]Option 
          
  
         	 
           
           [bookmark: pgfId-1532097]Description 
          
  
        
 
         
         	[bookmark: pgfId-1532099]Limit
  
         	[bookmark: pgfId-1532101]Logs and displays events for the specified number of packets (specified by the count argument) that trigger the rule during the specified time period. For example, if you set the type to Limit, the Count to 10, and the Seconds to 60, and 14 packets trigger the rule, the system stops logging events for the rule after displaying the first 10 that occur within the same minute.
  
        
 
         
         	[bookmark: pgfId-1532103]Threshold
  
         	[bookmark: pgfId-1532105]Logs and displays a single event when the specified number of packets (specified by the count argument) trigger the rule during the specified time period. Note that the counter for the time restarts after you hit the threshold count of events and the system logs that event. For example, you set the type to Threshold, Count to 10, and Seconds to 60, and the rule triggers 10 times by second 33. The system generates one event, then resets the Seconds and Count counters to 0. The rule then triggers another 10 times in the next 25 seconds. Because the counters reset to 0 at second 33, the system logs another event.
  
        
 
         
         	[bookmark: pgfId-1532107]Both
  
         	[bookmark: pgfId-1532109]Logs and displays an event once per specified time period, after the specified number (count) of packets trigger the rule. For example, if you set the type to Both, Count to 2, and Seconds to 10, the following event counts result:
 
           
           	 [bookmark: pgfId-1532110]If the rule is triggered once in 10 seconds, the system does not generate any events (the threshold is not met)
 
           	 [bookmark: pgfId-1532111]If the rule is triggered twice in 10 seconds, the system generates one event (the threshold is met when the rule triggers the second time)
 
           	 [bookmark: pgfId-1532112]If the rule is triggered four times in 10 seconds, the system generates one event (the threshold is met when the rule triggered the second time and following events are ignored)
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1532114]Next, specify the tracking, which determines whether the event instance count is calculated per source or destination IP address. Finally, specify the number of instances and time period that define the threshold.
 
     [bookmark: pgfId-1532135]
 
      
       
        
        [bookmark: pgfId-1532120]Table 35-2 Thresholding Instance/Time Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1532124]Option 
          
  
         	 
           
           [bookmark: pgfId-1532126]Description 
          
  
        
 
         
         	[bookmark: pgfId-1532128]Count
  
         	[bookmark: pgfId-1532130]The number of event instances per specified time period per tracking IP address or address range required to meet the threshold.
  
        
 
         
         	[bookmark: pgfId-1532132]Seconds
  
         	[bookmark: pgfId-1532134]The number of seconds that elapse before the count resets. If you set the threshold type to Limit, the tracking to Source, Count to 10, and Seconds to 10, the system logs and displays the first 10 events that occur in 10 seconds from a given source port. If only seven events occur in the first 10 seconds, the system logs and displays those, if 40 events occur in the first 10 seconds, the system logs and displays 10, then begins counting again when the 10-second time period elapses.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1532138][bookmark: 33372]Configuring Glo[bookmark: marker-1532137]bal Thresholds
 
    [bookmark: pgfId-1532145]License: Protection
 
    [bookmark: pgfId-1532146]You can set a global threshold to manage the number of events generated by each rule over a period of time. When you set a global threshold, that threshold applies for each rule that does not have an overriding specific threshold. For more information on configuring thresholds, see Understanding Thresholding.
 
    [bookmark: pgfId-1532150]A global threshold is configured on your system by default. The default values are as follows:
 
     
     	 [bookmark: pgfId-1532151] Type — Limit
 
     	 [bookmark: pgfId-1532152] Track By — Destination
 
     	 [bookmark: pgfId-1532153] Count — 1
 
     	 [bookmark: pgfId-1532154] Seconds — 60
 
    
 
    [bookmark: pgfId-1532155]To configure global thresholding:
 
    [bookmark: pgfId-1532159]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1532160]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1532161]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1532166]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1532170]The Policy Information page appears.
 
    [bookmark: pgfId-1532172]Step 3 [bookmark: 22526]Click Advanced Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1532173]The Advanced Settings page appears.
 
    [bookmark: pgfId-1532174]Step 4 You have two choices, depending on whether Global Rule Thresholding under Intrusion Rule Thresholds is enabled:
 
     
      
      	 [bookmark: pgfId-1532175]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1532176]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1532177]The Global Rule Thresholding page appears. A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1533826]Step 5 From the Type radio buttons, select the type of threshold that will apply over the time specified by the seconds argument. See the Thresholding Options table for more information:
 
     
      
      	 [bookmark: pgfId-1533830]Select  Limit  to log and display an event for each packet that triggers the rule until the limit specified by the count argument is exceeded.
 
      	 [bookmark: pgfId-1532183]Select  Threshold to log and display a single event for each packet that triggers the rule and represents either the instance that matches the threshold set by the count argument or is a multiple of the threshold.
 
      	 [bookmark: pgfId-1532184]Select  Both to log and display a single event after the number of packets specified by the count argument trigger the rule.
 
     
 
    
 
    [bookmark: pgfId-1532185]Step 6 Select the tracking method from the Track By radio buttons:
 
     
      
      	 [bookmark: pgfId-1532186]Select  Source to identify rule matches in traffic coming from a particular source IP address or addresses.
 
      	 [bookmark: pgfId-1532187]Select Destination to identify rule matches in traffic going to a particular destination IP address.
 
     
 
    
 
    [bookmark: pgfId-1532188]Step 7 In the Count field:
 
     
      
      	 [bookmark: pgfId-1533125]For a  Limit threshold, specify the number of event instances per specified time period per tracking IP address required to meet the threshold.
 
      	 [bookmark: pgfId-1532189]For a  Threshold threshold, specify the number of rule matches you want to use as your threshold. 
 
     
 
    
 
    [bookmark: pgfId-1532191]Step 8 In the Seconds field:
 
     
      
      	 [bookmark: pgfId-1532192]For a  Limit threshold, specify the number of seconds that make up the time period when attacks are tracked. 
 
      	 [bookmark: pgfId-1533857]For a  Threshold threshold, specify the number of seconds that elapse before the count resets. Note that the count resets if the number of rule matches indicated by the  Count field occur before the number of seconds indicated elapse.
 
     
 
    
 
    [bookmark: pgfId-1533879]Step 9 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-1533862]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1533865]Disabling the [bookmark: marker-1533863]Global [bookmark: marker-1536204]Threshold
 
     [bookmark: pgfId-1532208]License: Protection
 
     [bookmark: pgfId-1532209]By default, a global limit threshold limits the number of events on traffic going to a destination to one event per 60 seconds. You can disable global thresholding in the highest policy layer if you want to threshold events for specific rules and not apply thresholding to every rule by default.
 
     [bookmark: pgfId-1532210]To disable global thresholding:
 
     [bookmark: pgfId-1532214]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1532215]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
     [bookmark: pgfId-1532216]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
     
 
     [bookmark: pgfId-1532221]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
     [bookmark: pgfId-1532225]The Policy Information page appears.
 
     [bookmark: pgfId-1532227]Step 3 [bookmark: 60401]Click Settings in the navigation panel on the left.
 
     [bookmark: pgfId-1532228]The Settings page appears.
 
     [bookmark: pgfId-1533912]Step 4 Under Intrusion Rule Thresholds, disable Global Rule Thresholding. 
 
     [bookmark: pgfId-1533924]Step 5 Save your policy, continue editing, discard your changes, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
     [bookmark: pgfId-1533917]
 
      
      
 
     
 
     
 
      
       [bookmark: pgfId-1164863]
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-4901875][bookmark: 88979]Understanding and[bookmark: marker-4901874] Writing Intrusion Rules 
      
      
 
     
 
 
    [bookmark: pgfId-4905635]An intrusion rule is a specified set of keywords and arguments that detects attempts to exploit vulnerabilities on your network by analyzing network traffic to check if it matches the criteria in the rule. The system compares packets against the conditions specified in each rule and, if the packet data matches all the conditions specified in a rule, the rule triggers. If a rule is an alert rule, it generates an intrusion event. If it is a pass rule, it ignores the traffic. You can view and evaluate intrusion events from the Defense Center web interface.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-2322522] 
     Caution Make sure you use a controlled network environment to test any intrusion rules that you write before you use the rules in a production environment. Poorly written intrusion rules may seriously affect the performance of the system. 
      
      
 
     
 
    
 
    [bookmark: pgfId-3994277]Note the following:
 
     
     	 [bookmark: pgfId-3994219]For a  drop rule in an inline deployment, the system dr[bookmark: marker-3994218]ops the packet and generates an event. For more information on drop rules, see Setting Rule States. 
 
     	 [bookmark: pgfId-4542015]Cisco provides two typ[bookmark: marker-4542010]es of intrusion rule[bookmark: marker-4542011]s: shared object rules and standard text rules. The Cisco Vulnerability Research Team (VRT) can use shared object rules to detect attacks against vulnerabilities in ways that traditional standard text rules cannot. You cannot create shared object rules. When you write your own intrusion rule, you create a standard text rule.
 
    
 
    [bookmark: pgfId-1113601]You can write custom standard text rules to tune the types of events you are likely to see. Note that while this documentation sometimes discusses rules targeted to detect specific exploits, the most successful rules target traffic that may attempt to exploit known vulnerabilities rather than specific known exploits. By writing rules and specifying the rule’s event message, you can more easily identify traffic that indicates attacks and policy evasions. For more information about evaluating events, see Working with Intrusion Events.
 
    [bookmark: pgfId-4930593]When you enable a custom standard text rule in a custom intrusion policy, keep in mind that some rule keywords and arguments require that traffic first be decoded or preprocessed in a certain way. This chapter explains the options you must configure in your network analysis policy, which governs preprocessing. Note that if you disable a required preprocessor, the system automatically uses it with its current settings, although the preprocessor remains disabled in the network analysis policy web interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-4930594]Note Because preprocessing and intrusion inspection are so closely related, the network analysis and intrusion policies examining a single packet must complement each other. Tailoring preprocessing, especially using multiple custom network analysis policies, is an advanced task. For more information, see Limitations of Custom Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1073578]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1073616]Understanding Rule Anatomy describes the components, including the rule header and rule options, that make up a valid standard text rule.
 
     	 [bookmark: pgfId-4793873]Understanding Rule Headers provides a detailed description of the parts of a rule header.
 
     	 [bookmark: pgfId-4793877]Understanding Keywords and Arguments in Rules explains the usage and syntax of the intrusion rule keywords available in the FireSIGHT System.
 
     	 [bookmark: pgfId-4072978]Constructing a Rule explains how to build a new rule using the rule editor.
 
     	 [bookmark: pgfId-4072982]Searching for Rules explains how to search for existing rules.
 
     	 [bookmark: pgfId-2934989]Filtering Rules on the Rule Editor Page explains how to display a subset of rules to help you find specific rules.
 
    
 
   
 
    
     [bookmark: pgfId-2529868][bookmark: 80497][bookmark: 25665]Understanding Rule[bookmark: marker-2529867] Anatomy
 
    [bookmark: pgfId-4237706]License: Protection
 
    [bookmark: pgfId-1064169]All standard text rules contain two logical sections: the rule header and the rule options. The rule header contains:
 
     
     	 [bookmark: pgfId-2018215]the rule's action or type
 
     	 [bookmark: pgfId-1469206]the protocol
 
     	 [bookmark: pgfId-1469255]the source and destination IP addresses and netmasks
 
     	 [bookmark: pgfId-2018297]direction indicators showing the flow of traffic from source to destination
 
     	 [bookmark: pgfId-1469305]the source and destination ports
 
    
 
    [bookmark: pgfId-1469157]The rule options section contains:
 
     
     	 [bookmark: pgfId-1469476]event messages
 
     	 [bookmark: pgfId-1469561]keywords and their parameters and arguments
 
     	 [bookmark: pgfId-2018240]patterns that a packet’s payload must match to trigger the rule
 
     	 [bookmark: pgfId-1469603]specifications of which parts of the packet the rules engine should inspect 
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3632657]Note that the options section of a rule is the section enclosed in parentheses. The rule editor provides an easy-to-use interface to help you build standard text rules.
 
   
 
    
     [bookmark: pgfId-3632507][bookmark: 66535]Understanding [bookmark: marker-3632505]Rule[bookmark: marker-3632506] Headers
 
    [bookmark: pgfId-4542967]License: Protection
 
     
     [image: ] 
    
 
     
      
       
       [bookmark: pgfId-2419999]Table 36-1 [bookmark: 26083]Rule Header Values 
 
       
       
        
        	 
          
          [bookmark: pgfId-2420005]Rule Header Component 
         
  
        	 
          
          [bookmark: pgfId-2420007]Example Value 
         
  
        	 
          
          [bookmark: pgfId-2420009]This Value... 
         
  
       
 
        
        	[bookmark: pgfId-2420011]Action
  
        	[bookmark: pgfId-2420013]alert
  
        	[bookmark: pgfId-2420015]Generates an intrusion event when triggered.
  
       
 
        
        	[bookmark: pgfId-2420017]Protocol
  
        	[bookmark: pgfId-2420019]tcp 
  
        	[bookmark: pgfId-2420021]Tests TCP traffic only.
  
       
 
        
        	[bookmark: pgfId-2420023]Source IP Address
  
        	[bookmark: pgfId-2420025]$EXTERNAL_NET
  
        	[bookmark: pgfId-2420027]Tests traffic coming from any host that is not on your internal network.
  
       
 
        
        	[bookmark: pgfId-2420029]Source Ports
  
        	[bookmark: pgfId-2420031]any
  
        	[bookmark: pgfId-2420033]Tests traffic coming from any port on the originating host.
  
       
 
        
        	[bookmark: pgfId-2420035]Operator
  
        	[bookmark: pgfId-2420037]->
  
        	[bookmark: pgfId-2420039]Tests external traffic (destined for the web servers on your network).
  
       
 
        
        	[bookmark: pgfId-2420041]Destination IP Address
  
        	[bookmark: pgfId-2420043]$HTTP_SERVERS
  
        	[bookmark: pgfId-2420045]Tests traffic to be delivered to any host specified as a web server on your internal network.
  
       
 
        
        	[bookmark: pgfId-2420047]Destination Ports
  
        	[bookmark: pgfId-2420049]$HTTP_PORTS
  
        	[bookmark: pgfId-2420051]Tests traffic delivered to an HTTP port on your internal network.
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1059132]Note The previous example uses default variables, as do most intrusion rules. See Working with Variable Sets for more information about variables, what they mean, and how to configure them.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2008714]See the following sections for more information about rule header parameters:
 
     
     	 [bookmark: pgfId-2008718]Specifying Rule Actions describes rule types and explains how to specify the action that occurs when the rule triggers.
 
     	 [bookmark: pgfId-2008722]Specifying Protocols explains how to define the traffic protocol for traffic that the rule should test.
 
     	 [bookmark: pgfId-2008726]Specifying IP Addresses In Intrusion Rules explains how to define the individual IP addresses and IP address blocks in the rule header.
 
     	 [bookmark: pgfId-2008730]Defining Ports in Intrusion Rules explains how to define the individual ports and port ranges in the rule header.
 
     	 [bookmark: pgfId-2008734]Specifying Direction describes the available operators and explains how to specify the direction traffic must be traveling to be tested by the rule. 
 
    
 
     
      [bookmark: pgfId-1066754][bookmark: 40823]Specifying Rule[bookmark: marker-2334537] Actions[bookmark: marker-1059131]
 
     [bookmark: pgfId-4237786]License: Protection
 
     [bookmark: pgfId-1059133]Each rule header includes a parameter that specifies the action the system takes when a packet triggers a rule. Rules with the action set to alert generate an intrusion event against the packet that triggered the rule and log the details of that packet. Rules with the action set to pass do not generate an event against, or log the details of, the packet that triggered the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-3768351]Note In an inline deployment, rules with the rule state set to Drop and Generate Events generate an intrusion event against the packet that triggered the rule. Also, if you apply a drop rule in a passive deployment, the rule acts as an alert rule. For more information on drop rules, see Setting Rule States. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1163113]By default, pass rules override alert rules. You can create pass rules to prevent packets that meet criteria defined in the pass rule from triggering the alert rule in specific situations, rather than disabling the alert rule. For example, you might want a rule that looks for attempts to log into an FTP server as the user “anonymous” to remain active. However, if your network has one or more legitimate anonymous FTP servers, you could write and activate a pass rule that specifies that, for those specific servers, anonymous users do not trigger the original rule. 
 
     [bookmark: pgfId-2178391]Within the rule editor, you select the rule type from the Action list. For more information about the procedures you use to build a rule header using the rule editor, see Constructing a Rule.
 
    
 
     
      [bookmark: pgfId-1066869][bookmark: 65354]Specifying Protocols
 
     [bookmark: pgfId-4237803]License: Protection
 
     [bookmark: pgfId-1059165]In each rule header, you must specify the protocol of the traffic the rule inspects. You can specify the following network protocols for analysis:
 
      
      	 [bookmark: pgfId-1059168]ICMP (Internet Control Message Protocol)
 
      	 [bookmark: pgfId-4962833]IP (Internet Protocol)
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4962834]Note The system ignores port definitions in an intrusion rule header when the protocol is set to ip. For more information, see Defining Ports in Intrusion Rules.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-4962838]TCP (Transmission Control Protocol)
 
      	 [bookmark: pgfId-4962839]UDP (User Datagram Protocol)
 
     
 
     [bookmark: pgfId-1132478]Use IP as the protocol type to examine all protocols assigned by IANA, including TCP, UDP, ICMP, IGMP, and many more. See http://www.iana.org/assignments/protocol-numbers for a full list of IANA-assigned protocols.
 
      
       
     
 
     
 
     [bookmark: pgfId-1659536]Note You cannot currently write rules that match patterns in the next header (for example, the TCP header) in an IP payload. Instead, content matches begin with the last decoded protocol. As a workaround, you can match patterns in TCP headers by using rule options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666461]Within the rule editor, you select the protocol type from the Protocol list. See Constructing a Rule for more information about the procedures you use to build a rule header using the rule editor.
 
    
 
     
      [bookmark: pgfId-4666468][bookmark: 23807]Specify[bookmark: marker-4666466]ing IP A[bookmark: marker-4666467]ddresses In Intrusion Rules
 
     [bookmark: pgfId-4666472]License: Protection
 
     [bookmark: pgfId-4666473]Restricting packet inspection to the packets originating from specific IP addresses or destined to a specific IP address reduces the amount of packet inspection the system must perform. This also reduces false positives by making the rule more specific and removing the possibility of the rule triggering against packets whose source and destination IP addresses do not indicate suspicious behavior.
 
      
       
     
 
     
 
     [bookmark: pgfId-4666474]Tip The system recognizes only IP addresses and does not accept host names for source or destination IP addresses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666475]Within the rule editor, you specify source and destination IP addresses in the Source IPs and Destination IPs fields. See Constructing a Rule for more information about the procedures you use to build a rule header using the rule editor.
 
     [bookmark: pgfId-4666482]When writing standard text rules, you can specify IPv4 and IPv6 addresses in a variety of ways, depending on your needs. You can specify a single IP address, any, IP address lists, CIDR notation, prefix lengths, a network variable, or a network object or network object group. Additionally, you can indicate that you want to exclude a specific IP address or set of IP addresses. When specifying IPv6 addresses, you can use any addressing convention defined in RFC 4291.
 
      
       
        
        [bookmark: pgfId-4905881]Table 36-2 [bookmark: 46782]Source/Destination IP Address Syntax 
 
        
        
         
         	 
           
           [bookmark: pgfId-4905887]To Specify... 
          
  
         	 
           
           [bookmark: pgfId-4905889]Use... 
          
  
         	 
           
           [bookmark: pgfId-4905891]Example 
          
  
        
 
         
         	[bookmark: pgfId-4905893]any IP address
  
         	[bookmark: pgfId-4905895]any
  
         	[bookmark: pgfId-4905897]any
  
        
 
         
         	[bookmark: pgfId-4905899]a specific IP address
  
         	[bookmark: pgfId-4905901]the IP address
 [bookmark: pgfId-4905902]Note that you would not mix IPv4 and IPv6 source and destination addresses in the same rule.
  
         	[bookmark: pgfId-4905904]192.168.1.1
 [bookmark: pgfId-4905905]2001:db8::abcd
  
        
 
         
         	[bookmark: pgfId-4905907]a list of IP addresses
  
         	[bookmark: pgfId-4905909]brackets ([]) to enclose the IP addresses and commas to separate them 
  
         	[bookmark: pgfId-4905911][192.168.1.1,192.168.1.15]
 [bookmark: pgfId-4905912][2001:db8::b3ff, 2001:db8::0202]
  
        
 
         
         	[bookmark: pgfId-4905914]a block of IP addresses
  
         	[bookmark: pgfId-4905916]IPv4 CIDR block or IPv6 address prefix notation 
  
         	[bookmark: pgfId-4905918]192.168.1.0/24
 [bookmark: pgfId-4905919]2001:db8::/32
  
        
 
         
         	[bookmark: pgfId-4905921]anything except a specific IP address or set of addresses 
  
         	[bookmark: pgfId-4905923]the ! character before the IP address or addresses you want to negate
  
         	[bookmark: pgfId-4905925]!192.168.1.15
 [bookmark: pgfId-4905926]!2001:db8::0202:b3ff:fe1e
  
        
 
         
         	[bookmark: pgfId-4905928]anything in a block of IP addresses except one or more specific IP addresses
  
         	[bookmark: pgfId-4905930]a block of addresses followed by a list of negated addresses or blocks
  
         	[bookmark: pgfId-4905932][10.0.0/8, !10.2.3.4, !10.1.0.0/16]
 [bookmark: pgfId-4905933][2001:db8::/32, !2001:db8::8329, !2001:db8::0202]
  
        
 
         
         	[bookmark: pgfId-4905935]IP addresses defined by a network variable
  
         	[bookmark: pgfId-4905937]the variable name, in uppercase letters, preceded by $
 [bookmark: pgfId-4905938]Note that preprocessor rules can trigger events regardless of the hosts defined by network variables used in intrusion rules. See Working with Variable Sets for more information.
  
         	[bookmark: pgfId-4905943]$HOME_NET
  
        
 
         
         	[bookmark: pgfId-4905945]all IP addresses except addresses defined by an IP address variable
  
         	[bookmark: pgfId-4905947]the variable name, in uppercase letters, preceded by !$
 [bookmark: pgfId-4905950]See Excluding IP Addresses in Intrusion Rules for more information.
  
         	[bookmark: pgfId-4905953]!$HOME_NET
  
        
 
         
         	[bookmark: pgfId-4905955]IP addresses defined by a network object or network object group
  
         	[bookmark: pgfId-4905957]the object or group name using the format !{object_name}.
 [bookmark: pgfId-4905960]See Working with Network Objects for more information.
  
         	[bookmark: pgfId-4905963]${192.168sub16}
  
        
 
         
         	[bookmark: pgfId-4905965]all IP addresses except addresses defined by a network object or network object group
  
         	[bookmark: pgfId-4905967]the object or group name, in curly braces ({}), preceded by !$.
 [bookmark: pgfId-4905970]See Working with Network Objects for more information.
  
         	[bookmark: pgfId-4905973]!${192.168sub16}
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4666584]See the following sections for more in-depth information about the syntax you can use to specify source and destination IP addresses, and for information about using variables to specify IP addresses:
 
      
      	 [bookmark: pgfId-4666588]IP Address Conventions.
 
      	 [bookmark: pgfId-4666592]Working with Variable Sets
 
      	 [bookmark: pgfId-4666596]Specifying Any IP Address
 
      	 [bookmark: pgfId-4666600]Specifying Multiple IP Addresses
 
      	 [bookmark: pgfId-4666604]Specifying Network Objects
 
      	 [bookmark: pgfId-4666608]Excluding IP Addresses in Intrusion Rules
 
     
 
    
 
     
      [bookmark: pgfId-4666611][bookmark: 56029]Sp[bookmark: marker-4666610]ecifying Any IP Address
 
     [bookmark: pgfId-4666615]License: Protection
 
     [bookmark: pgfId-4666616]You can specify the word any as a rule source or destination IP address to indicate any IPv4 or IPv6 address.
 
     [bookmark: pgfId-4666617]For example, the following rule uses the argument any in the Source IPs and Destination IPs fields and evaluates packets with any IPv4 or IPv6 source or destination address:
 
      
      [bookmark: pgfId-4666618]alert tcp any any -> any any 
     
 
     [bookmark: pgfId-4666619]You can also specify :: to indicate any IPv6 address.
 
    
 
     
      [bookmark: pgfId-4666621][bookmark: 45634]Specifying Multiple IP Addresses
 
     [bookmark: pgfId-4666625]License: Protection
 
     [bookmark: pgfId-4666626]You can list individual IP addresses by separating the IP addresses with commas and, optionally, by surrounding non-negated lists with brackets, as shown in the following example:
 
      
      [bookmark: pgfId-4666627][192.168.1.100,192.168.1.103,192.168.1.105] 
     
 
     [bookmark: pgfId-4666628]You can list IPv4 and IPv6 addresses alone or in any combination, as shown in the following example:
 
      
      [bookmark: pgfId-4666629][192.168.1.100,2001:db8::1234,192.168.1.105] 
     
 
     [bookmark: pgfId-4666630]Note that surrounding an IP address list with brackets, which was required in earlier software releases, is not required. Note also that, optionally, you can enter lists with a space before or after each comma.
 
      
       
     
 
     
 
     [bookmark: pgfId-4666633]Note You must surround negated lists with brackets. See Excluding IP Addresses in Intrusion Rules for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666635]You can also use IPv4 Classless Inter-Domain Routing (CIDR) notation or IPv6 prefix lengths to specify address blocks. For example:
 
      
      	 [bookmark: pgfId-4666636]192.168.1.0/24 specifies the IPv4 addresses in the 192.168.1.0 network with a subnet mask of 255.255.255.0, that is, 192.168.1.0 through 192.168.1.255. For more information, see IP Address Conventions.
 
      	 [bookmark: pgfId-4666640]2001:db8::/32 specifies the IPv6 addresses in the 2001:db8:: network with a prefix length of 32 bits, that is, 2001:db8:: through 2001:db8:ffff:ffff:ffff:ffff:ffff:ffff.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4666641]Tip If you need to specify a block of IP addresses but cannot express it using CIDR or prefix length notation alone, you can use CIDR blocks and prefix lengths in an IP address list.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4666644][bookmark: 56620]Sp[bookmark: marker-4666643]ecifying Network Objects
 
     [bookmark: pgfId-4666648]License: Protection
 
     [bookmark: pgfId-4666649]You can specify a network object or network object group using the syntax: 
 
      
      [bookmark: pgfId-4666650]${object_name | group_name} 
     
 
     [bookmark: pgfId-4666651]where:
 
      
      	 [bookmark: pgfId-4666652] object_name is the name of a network object
 
      	 [bookmark: pgfId-4666653] group_name is the name of a network object group
 
     
 
     [bookmark: pgfId-4666657]See Working with Network Objects for information on creating network objects and network object groups.
 
     [bookmark: pgfId-4666658]Consider the case where you have created a network object named 192.168sub16 and a network object group named all_subnets. You could specify the following to identify IP addresses using the network object:
 
      
      [bookmark: pgfId-4666659]${192.168sub16} 
     
 
     [bookmark: pgfId-4666660]and you could specify the following to use the network object group:
 
      
      [bookmark: pgfId-4666661]${all_subnets} 
     
 
     [bookmark: pgfId-4666662]You can also use negation with network objects and network object groups. For example:
 
      
      [bookmark: pgfId-4666663]!${192.168sub16} 
     
 
     [bookmark: pgfId-4666667]See Excluding IP Addresses in Intrusion Rules for more information.
 
    
 
     
      [bookmark: pgfId-4666672][bookmark: 89897][bookmark: 70264][bookmark: 58068]Excl[bookmark: marker-4666671]uding IP Addresses in Intrusion Rules
 
     [bookmark: pgfId-4666676]License: Protection
 
     [bookmark: pgfId-4666677]You can use an exclamation point (!) to negate a specified IP address. That is, you can match any IP address with the exception of the specified IP address or addresses. For example, !192.168.1.1 specifies any IP address other than 192.168.1.1, and !2001:db8:ca2e::fa4c specifies any IP address other than 2001:db8:ca2e::fa4c.
 
     [bookmark: pgfId-4666678]To negate a list of IP addresses, place ! before a bracketed list of IP addresses. For example, ![192.168.1.1,192.168.1.5] would define any IP address other than 192.168.1.1 or 192.168.1.5.
 
      
       
     
 
     
 
     [bookmark: pgfId-4666679]Note You must use brackets to negate a list of IP addresses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666680]Be careful when using the negation character with IP address lists. For example, if you use [!192.168.1.1,!192.168.1.5] to match any address that is not 192.168.1.1 or 192.168.1.5, the system interprets this syntax as “anything that is not 192.168.1.1, or anything that is not 192.168.1.5.”
 
     [bookmark: pgfId-4666681]Because 192.168.1.5 is not 192.168.1.1, and 192.168.1.1 is not 192.168.1.5, both IP addresses match the IP address value of [!192.168.1.1,!192.168.1.5], and it is essentially the same as using “any.”
 
     [bookmark: pgfId-4666682]Instead, use ![192.168.1.1,192.168.1.5]. The system interprets this as “not 192.168.1.1 and not 192.168.1.5,” which matches any IP address other than those listed between brackets.
 
     [bookmark: pgfId-4666683]Note that you cannot logically use negation with any which, if negated, would indicate no address.
 
    
 
     
      [bookmark: pgfId-4666686][bookmark: 85429]Defining Ports in Intrusion R[bookmark: marker-4666685]ules
 
     [bookmark: pgfId-4666690]License: Protection
 
     [bookmark: pgfId-4666691]Within the rule editor, you specify source and destination ports in the Source Port and Destination Port fields. See Constructing a Rule for more information about the procedures you use to build a rule header using the rule editor.
 
     [bookmark: pgfId-4666698]The FireSIGHT System uses a specific type of syntax to define the port numbers used in rule headers.
 
      
       
     
 
     
 
     [bookmark: pgfId-4666699]Note The system ignores port definitions in an intrusion rule header when the protocol is set to ip. For more information, see Specifying Protocols.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4666703]You can list ports by separating the ports with commas, as shown in the following example:
 
      
      [bookmark: pgfId-4666704]80, 8080, 8138, 8600-9000, !8650-8675 
     
 
     [bookmark: pgfId-4666705]Optionally, the following example shows how you can surround a port list with brackets, which was required in previous software versions but is no longer required:
 
      
      [bookmark: pgfId-4666706][80, 8080, 8138, 8600-9000, !8650-8675] 
     
 
     [bookmark: pgfId-4666707]Note that you must surround negated port lists in brackets, as shown in the following example:
 
      
      [bookmark: pgfId-4666708]![20, 22, 23] 
     
 
     [bookmark: pgfId-4666709]Note also that a list of source or destination ports in an intrusion rule can include a maximum of 64 characters.
 
      
       
        
        [bookmark: pgfId-4907235]Table 36-3 [bookmark: 61865]Source/Destination Port Syntax 
 
        
        
         
         	 
           
           [bookmark: pgfId-4907241]To Specify... 
          
  
         	 
           
           [bookmark: pgfId-4907243]Use 
          
  
         	 
           
           [bookmark: pgfId-4907245]Example 
          
  
        
 
         
         	[bookmark: pgfId-4907247]any port
  
         	[bookmark: pgfId-4907249]any
  
         	[bookmark: pgfId-4907251]any
  
        
 
         
         	[bookmark: pgfId-4907253]a specific port
  
         	[bookmark: pgfId-4907255]the port number
  
         	[bookmark: pgfId-4907257]80
  
        
 
         
         	[bookmark: pgfId-4907259]a range of ports
  
         	[bookmark: pgfId-4907261]a dash between the first and last port number in the range
  
         	[bookmark: pgfId-4907263]80-443
  
        
 
         
         	[bookmark: pgfId-4907265]all ports less than or equal to a specific port 
  
         	[bookmark: pgfId-4907267]a dash before the port number
  
         	[bookmark: pgfId-4907269]-21
  
        
 
         
         	[bookmark: pgfId-4907271]all ports greater than or equal to a specific port 
  
         	[bookmark: pgfId-4907273]a dash after the port number
  
         	[bookmark: pgfId-4907275]80-
  
        
 
         
         	[bookmark: pgfId-4907277]all ports except a specific port or range of ports
  
         	[bookmark: pgfId-4907279]the ! character before the port, port list, or range of ports you want to negate 
 [bookmark: pgfId-4907280]Note that you can logically use negation with all port designations except any, which if negated would indicate no port.
  
         	[bookmark: pgfId-4907282]!20
  
        
 
         
         	[bookmark: pgfId-4907284]all ports defined by a port variable
  
         	[bookmark: pgfId-4907286]the variable name, in uppercase letter, preceded by $
 [bookmark: pgfId-4907290]See Working with Port Variables for more information.
  
         	[bookmark: pgfId-4907292]$HTTP_PORTS
  
        
 
         
         	[bookmark: pgfId-4907294]all ports except ports defined by a port variable
  
         	[bookmark: pgfId-4907296]the variable name, in uppercase letter, preceded by !$
  
         	[bookmark: pgfId-4907298]!$HTTP_PORTS
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-4666788][bookmark: 96359]Specify[bookmark: marker-4666787]ing Direction
 
     [bookmark: pgfId-4237854]License: Protection
 
      
       
        
        [bookmark: pgfId-1466701]Table 36-4 [bookmark: 10879]Directional Options in Rule Headers 
 
        
        
         
         	 
           
           [bookmark: pgfId-1466705]Use... 
          
  
         	 
           
           [bookmark: pgfId-1466707]To Test... 
          
  
        
 
         
         	[bookmark: pgfId-1466709]Directional
  
         	[bookmark: pgfId-1466711]only traffic from the specified source IP address to the specified destination IP address
  
        
 
         
         	[bookmark: pgfId-1466713]Bidirectional
  
         	[bookmark: pgfId-1466715]all traffic traveling between the specified source and destination IP addresses
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1403050]See Constructing a Rule for more information about the procedures you use to build a rule header using the rule editor.
 
    
 
   
 
    
     [bookmark: pgfId-1058616][bookmark: 74878]Understand[bookmark: marker-1058615]ing Keywords and Arguments in Rules
 
    [bookmark: pgfId-4237875]License: Protection
 
    [bookmark: pgfId-1058617]Using the rules language, you can specify the behavior of a rule by combining keywords. Keywords and their associated values (called arguments) dictate how the system evaluates packets and packet-related values that the rules engine tests. The FireSIGHT System currently supports keywords that allow you to perform inspection functions, such as content matching, protocol-specific pattern matching, and state-specific matching. You can define up to 100 arguments per keyword, and combine any number of compatible keywords to create highly specific rules. This helps decrease the chance of false positives and false negatives and focus the intrusion information you receive.
 
    [bookmark: pgfId-4566707]Note that you can also use adaptive profiles to dynamically adapt active rule processing for specific packets based on rule metadata and host information. For more information, see Tuning Preprocessing in Passive Deployments.
 
    [bookmark: pgfId-1091258]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1091259]Defining Intrusion Event Details describes the syntax and use of keywords that allow you to define the event’s message, priority information, and references to external information about the exploit the rule detects.
 
     	 [bookmark: pgfId-4788590]Searching for Content Matches describes how to use the  content  or  protected_content  keywords to test the content of the packet payload.
 
     	 [bookmark: pgfId-4788594]Constraining Content Matches describes how to use modifying keywords for the  content or  protected_content  keywords.
 
     	 [bookmark: pgfId-4002749]Replacing Content in Inline Deployments describes how to use the  replace keyword in inline deployments to replace specified content of equal length.
 
     	 [bookmark: pgfId-1728911]Using Byte_Jump and Byte_Test describes how to use the  byte_jump and  byte_test keywords to calculate where in a packet the rules engine should begin testing for a content match, and which bytes it should evaluate.
 
     	 [bookmark: pgfId-1148902]Searching for Content Using PCRE describes how to use the  pcre keyword to use Perl-compatible regular expressions in rules.
 
     	 [bookmark: pgfId-2641029]Adding Metadata to a Rule describes how to use the  metadata keyword to add information to a rule.
 
     	 [bookmark: pgfId-1091271]Inspecting IP Header Values describes the syntax and use of keywords that test values in the packet’s IP header.
 
     	 [bookmark: pgfId-1091276]Inspecting ICMP Header Values describes the syntax and use of keywords that test values in the packet’s ICMP header.
 
     	 [bookmark: pgfId-4113879]Inspecting TCP Header Values and Stream Size describes the syntax and use of keywords that test values in the packet’s TCP header.
 
     	 [bookmark: pgfId-4113959]Enabling and Disabling TCP Stream Reassembly describes how to enable and disable stream reassembly for a single connection when inspected traffic on the connection matches the conditions of the rule.
 
     	 [bookmark: pgfId-4113963]Extracting SSL Information from a Session describes the use and syntax of keywords that extract version and state information from encrypted traffic.
 
     	 [bookmark: pgfId-4002765]Reading Packet Data into Keyword Arguments describes how to read a value from a packet into a variable that you can use later in the same rule to specify the value for arguments in certain other keywords.
 
     	 [bookmark: pgfId-2763410]Inspecting Application Layer Protocol Values describes the use and syntax of keywords that test application layer protocol properties.
 
     	 [bookmark: pgfId-1091389]Inspecting Packet Characteristics describes the use and syntax of the  dsize ,  sameIP ,  isdataat ,  fragoffset , and  cvs keywords.
 
     	 [bookmark: pgfId-4002773]Initiating Active Responses with Rule Keywords explains how to use the  resp keyword to actively close TCP connections or UDP sessions, the  react keyword to send an HTML page and then actively close TCP connections, and the  config response command to specify the active response interface and the number of TCP resets to attempt in a passive deployment.
 
     	 [bookmark: pgfId-3455995]Filtering Events describes how to prevent a rule from triggering an event unless a specified number packets meet the rule’s detection criteria within a specified time.
 
     	 [bookmark: pgfId-3157541]Evaluating Post-Attack Traffic describes how to log additional traffic for the host or session.
 
     	 [bookmark: pgfId-3719307]Detecting Attacks That Span Multiple Packets describes how to assign state names to packets from attacks that span multiple packets in a single session, then analyze and alert on packets according to their state.
 
     	 [bookmark: pgfId-3719311]Generating Events on the HTTP Encoding Type and Location describes how to generate events on the type of encoding in an HTTP request or response URI, header, or cookie, including set-cookies, before normalization.
 
     	 [bookmark: pgfId-4876221]Detecting File Types and Versions describes how to point to a specific file type or file version using the  file_type or  file_group keyword.
 
     	 [bookmark: pgfId-4876225]Pointing to a Specific Payload Type describes how to point to the beginning of the HTTP response entity body, SMTP payload, or encoded email attachment.
 
     	 [bookmark: pgfId-4216431]Pointing to the Beginning of the Packet Payload describes how to point to the beginning of the packet payload.
 
     	 [bookmark: pgfId-3719315]Decoding and Inspecting Base64 Data describes how you can use the  base64_decode and  base64_data keywords to decode and inspect Base64 data, especially in HTTP requests.
 
    
 
     
      [bookmark: pgfId-2174772][bookmark: 25305]Defining Intrusion [bookmark: marker-4517522]Event Details
 
     [bookmark: pgfId-4237888]License: Protection
 
     [bookmark: pgfId-2019984]As you construct a standard text rule, you can include contextual information that describes the vulnerability that the rule detects attempts to exploit. You can also include external references to vulnerability databases and define the priority that the event holds in your organization. When analysts see the event, they then have information about the priority, exploit, and known mitigation readily available.
 
     [bookmark: pgfId-1091627]See the following sections for more information about event-related keywords:
 
      
      	 [bookmark: pgfId-1091628]Defining the Event Message
 
      	 [bookmark: pgfId-1990813]Defining the Event Priority
 
      	 [bookmark: pgfId-1161938]Defining the Intrusion Event Classification
 
      	 [bookmark: pgfId-1161942]Defining the Event Reference
 
     
 
    
 
     
      [bookmark: pgfId-1161944][bookmark: 62740]Defining the Event Message[bookmark: marker-1161978]
 
     [bookmark: pgfId-4237901]License: Protection
 
     [bookmark: pgfId-1133271]You can specify meaningful text that appears as a message when the rule triggers. The message gives immediate insight into the nature of the vulnerability that the rule detects attempts to exploit. You can use any printable standard ASCII characters except curly braces ({}). The system strips quotes that completely surround the message.
 
      
       
     
 
     
 
     [bookmark: pgfId-2267557]Tip You must specify a rule message. Also, the message cannot consist of white space only, one or more quotation marks only, one or more apostrophes only, or any combination of just white space, quotation marks, or apostrophes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1133274]To define the event message in the rule editor, enter the event message in the Message field. See Constructing a Rule for more information about using the rule editor to build rules.
 
    
 
     
      [bookmark: pgfId-1990460][bookmark: 58759]Defining the Ev[bookmark: marker-3534896]ent Priority
 
     [bookmark: pgfId-4237914]License: Protection
 
     [bookmark: pgfId-1990461]By default, the priority of a rule derives from the event classification for the rule. However, you can override the classification priority for a rule by adding the priority keyword to the rule.
 
     [bookmark: pgfId-1990706]To specify a priority using the rule editor, select priority from the Detection Options list, and select high, medium, or low from the drop-down list. For example, to assign a high priority for a rule that detects web application attacks, add the priority keyword to the rule and select high as the priority. See Constructing a Rule for more information about using the rule editor to build rules.
 
    
 
     
      [bookmark: pgfId-1070349][bookmark: 38136]Defining the Intrusion Event Classification[bookmark: marker-1161976]
 
     [bookmark: pgfId-4237927]License: Protection
 
     [bookmark: pgfId-1068375]For each rule, you can specify an attack classification that appears in the packet display of the event. The following table lists the name and number for each classification.
 
     [bookmark: pgfId-4540023][bookmark: 71706]
 
      
       
        
        [bookmark: pgfId-4907821]Table 36-5 [bookmark: 28264]Rule Classifications 
 
        
        
         
         	 
           
           [bookmark: pgfId-4907827]Number 
          
  
         	 
           
           [bookmark: pgfId-4907829]Classification Name 
          
  
         	 
           
           [bookmark: pgfId-4907831]Description 
          
  
        
 
         
         	[bookmark: pgfId-4907833]1
  
         	[bookmark: pgfId-4907835]not-suspicious
  
         	[bookmark: pgfId-4907837]Not Suspicious Traffic
  
        
 
         
         	[bookmark: pgfId-4907839]2
  
         	[bookmark: pgfId-4907841]unknown
  
         	[bookmark: pgfId-4907843]Unknown Traffic
  
        
 
         
         	[bookmark: pgfId-4907845]3
  
         	[bookmark: pgfId-4907847]bad-unknown
  
         	[bookmark: pgfId-4907849]Potentially Bad Traffic
  
        
 
         
         	[bookmark: pgfId-4907851]4
  
         	[bookmark: pgfId-4907853]attempted-recon
  
         	[bookmark: pgfId-4907855]Attempted Information Leak
  
        
 
         
         	[bookmark: pgfId-4907857]5
  
         	[bookmark: pgfId-4907859]successful-recon-limited
  
         	[bookmark: pgfId-4907861]Information Leak
  
        
 
         
         	[bookmark: pgfId-4907863]6
  
         	[bookmark: pgfId-4907865]successful-recon-largescale
  
         	[bookmark: pgfId-4907867]Large Scale Information Leak
  
        
 
         
         	[bookmark: pgfId-4907869]7
  
         	[bookmark: pgfId-4907871]attempted-dos
  
         	[bookmark: pgfId-4907873]Attempted Denial of Service
  
        
 
         
         	[bookmark: pgfId-4907875]8
  
         	[bookmark: pgfId-4907877]successful-dos
  
         	[bookmark: pgfId-4907879]Denial of Service
  
        
 
         
         	[bookmark: pgfId-4907881]9
  
         	[bookmark: pgfId-4907883]attempted-user
  
         	[bookmark: pgfId-4907885]Attempted User Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907887]10
  
         	[bookmark: pgfId-4907889]unsuccessful-user
  
         	[bookmark: pgfId-4907891]Unsuccessful User Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907893]11
  
         	[bookmark: pgfId-4907895]successful-user
  
         	[bookmark: pgfId-4907897]Successful User Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907899]12
  
         	[bookmark: pgfId-4907901]attempted-admin
  
         	[bookmark: pgfId-4907903]Attempted Administrator Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907905]13
  
         	[bookmark: pgfId-4907907]successful-admin
  
         	[bookmark: pgfId-4907909]Successful Administrator Privilege Gain
  
        
 
         
         	[bookmark: pgfId-4907911]14
  
         	[bookmark: pgfId-4907913]rpc-portmap-decode
  
         	[bookmark: pgfId-4907915]Decode of an RPC Query
  
        
 
         
         	[bookmark: pgfId-4907917]15
  
         	[bookmark: pgfId-4907919]shellcode-detect
  
         	[bookmark: pgfId-4907921]Executable Code was Detected
  
        
 
         
         	[bookmark: pgfId-4907923]16
  
         	[bookmark: pgfId-4907925]string-detect
  
         	[bookmark: pgfId-4907927]A Suspicious String was Detected
  
        
 
         
         	[bookmark: pgfId-4907929]17
  
         	[bookmark: pgfId-4907931]suspicious-filename-detect
  
         	[bookmark: pgfId-4907933]A Suspicious Filename was Detected
  
        
 
         
         	[bookmark: pgfId-4907935]18
  
         	[bookmark: pgfId-4907937]suspicious-login
  
         	[bookmark: pgfId-4907939]An Attempted Login Using a Suspicious Username was Detected
  
        
 
         
         	[bookmark: pgfId-4907941]19
  
         	[bookmark: pgfId-4907943]system-call-detect
  
         	[bookmark: pgfId-4907945]A System Call was Detected
  
        
 
         
         	[bookmark: pgfId-4907947]20
  
         	[bookmark: pgfId-4907949]tcp-connection
  
         	[bookmark: pgfId-4907951]A TCP Connection was Detected
  
        
 
         
         	[bookmark: pgfId-4907953]21
  
         	[bookmark: pgfId-4907955]trojan-activity
  
         	[bookmark: pgfId-4907957]A Network Trojan was Detected
  
        
 
         
         	[bookmark: pgfId-4907959]22
  
         	[bookmark: pgfId-4907961]unusual-client-port-connection
  
         	[bookmark: pgfId-4907963]A Client was Using an Unusual Port
  
        
 
         
         	[bookmark: pgfId-4907965]23
  
         	[bookmark: pgfId-4907967]network-scan
  
         	[bookmark: pgfId-4907969]Detection of a Network Scan
  
        
 
         
         	[bookmark: pgfId-4907971]24
  
         	[bookmark: pgfId-4907973]denial-of-service
  
         	[bookmark: pgfId-4907975]Detection of a Denial of Service Attack
  
        
 
         
         	[bookmark: pgfId-4907977]25
  
         	[bookmark: pgfId-4907979]non-standard-protocol
  
         	[bookmark: pgfId-4907981]Detection of a Non-Standard Protocol or Event
  
        
 
         
         	[bookmark: pgfId-4907983]26
  
         	[bookmark: pgfId-4907985]protocol-command-decode
  
         	[bookmark: pgfId-4907987]Generic Protocol Command Decode
  
        
 
         
         	[bookmark: pgfId-4907989]27
  
         	[bookmark: pgfId-4907991]web-application-activity
  
         	[bookmark: pgfId-4907993]Access to a Potentially Vulnerable Web Application
  
        
 
         
         	[bookmark: pgfId-4907995]28
  
         	[bookmark: pgfId-4907997]web-application-attack
  
         	[bookmark: pgfId-4907999]Web Application Attack
  
        
 
         
         	[bookmark: pgfId-4908001]29
  
         	[bookmark: pgfId-4908003]misc-activity
  
         	[bookmark: pgfId-4908005]Misc Activity
  
        
 
         
         	[bookmark: pgfId-4908007]30
  
         	[bookmark: pgfId-4908009]misc-attack
  
         	[bookmark: pgfId-4908011]Misc Attack
  
        
 
         
         	[bookmark: pgfId-4908013]31
  
         	[bookmark: pgfId-4908015]icmp-event
  
         	[bookmark: pgfId-4908017]Generic ICMP Event
  
        
 
         
         	[bookmark: pgfId-4908019]32
  
         	[bookmark: pgfId-4908021]inappropriate-content
  
         	[bookmark: pgfId-4908023]Inappropriate Content was Detected
  
        
 
         
         	[bookmark: pgfId-4908025]33
  
         	[bookmark: pgfId-4908027]policy-violation
  
         	[bookmark: pgfId-4908029]Potential Corporate Privacy Violation
  
        
 
         
         	[bookmark: pgfId-4908031]34
  
         	[bookmark: pgfId-4908033]default-login-attempt
  
         	[bookmark: pgfId-4908035]Attempt to Login By a Default Username and Password
  
        
 
         
         	[bookmark: pgfId-4908037]35
  
         	[bookmark: pgfId-4908039]sdf
  
         	[bookmark: pgfId-4908041]Sensitive Data
  
        
 
         
         	[bookmark: pgfId-4908043]36
  
         	[bookmark: pgfId-4908045]malware-cnc
  
         	[bookmark: pgfId-4908047]Known malware command and control traffic
  
        
 
         
         	[bookmark: pgfId-4908049]37
  
         	[bookmark: pgfId-4908051]client-side-exploit
  
         	[bookmark: pgfId-4908053]Known client side exploit attempt
  
        
 
         
         	[bookmark: pgfId-4908055]38
  
         	[bookmark: pgfId-4908057]file-format
  
         	[bookmark: pgfId-4908059]Known malicious file or file based exploit
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2208939]To specify a classification in the rule editor, select a classification from the Classification list. See Writing New Rules for more information on the rule editor.
 
     [bookmark: pgfId-1526282][bookmark: 52255]Adding Custom Classifications
 
     [bookmark: pgfId-4237942]License: Protection
 
     [bookmark: pgfId-4961678]If you want more customized content for the packet display description of the events generated by a rule you define, create a custom classification.
 
     [bookmark: pgfId-4961679]To add classifications to the Classification list:
 
     [bookmark: pgfId-4961683]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4961684]Step 1 Select Policies > Intrusion > Rule Editor.
 
     [bookmark: pgfId-1895383]The Rule Editor page appears.
 
     [bookmark: pgfId-1895497]Step 2 Click Create Rule. 
 
     [bookmark: pgfId-1937756]The Create Rule page appears.
 
     [bookmark: pgfId-1516150]Step 3 Under the Classification drop-down list, click Edit Classifications.
 
     [bookmark: pgfId-1516277]A pop-up window appears.
 
     [bookmark: pgfId-1516280]Step 4 Type the name of the classification in the Classification Name field.
 
     [bookmark: pgfId-1656602]You can use up to 255 alphanumeric characters, but the page is difficult to read if you use more than 40 characters. The following characters are not supported: <>()\'"&$; and the space character.
 
     [bookmark: pgfId-1516316]Step 5 Type a description of the classification in the Classification Description field.
 
     [bookmark: pgfId-1656604]You can use up to 255 alphanumeric characters and spaces. The following characters are not supported: <>()\'"&$;
 
     [bookmark: pgfId-1516349]Step 6 Select a priority from the Priority list.
 
     [bookmark: pgfId-1516397]You can select high, medium, or low.
 
     [bookmark: pgfId-1516423]Step 7 Click Add.
 
     [bookmark: pgfId-2011503]The new classification is added to the list and becomes available for use in the rule editor.
 
     [bookmark: pgfId-2020727]Step 8 Click Done.
 
     [bookmark: pgfId-4774522]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2187126][bookmark: 72334]Defining the Event Reference[bookmark: marker-2187125]
 
     [bookmark: pgfId-4237965]License: Protection
 
     [bookmark: pgfId-2187127]You can use the reference keyword to add references to external web sites and additional information about the event. Adding a reference provides analysts with an immediately available resource to help them identify why the packet triggered a rule. The following table lists some of the external systems that can provide data on known exploits and attacks.
 
     [bookmark: pgfId-1071105]
 
      
       
        
        [bookmark: pgfId-1447552]Table 36-6 [bookmark: 99506]External Attack Identification Systems 
 
        
        
         
         	 
           
           [bookmark: pgfId-1071108]System ID 
          
  
         	 
           
           [bookmark: pgfId-1071110]Description 
          
  
         	 
           
           [bookmark: pgfId-1134221]Example ID 
          
  
        
 
         
         	[bookmark: pgfId-1071112]bugtraq
  
         	[bookmark: pgfId-1071114]Bugtraq page
  
         	[bookmark: pgfId-1134223]8550
  
        
 
         
         	[bookmark: pgfId-1071116]cve
  
         	[bookmark: pgfId-1071118]Common Vulnerabilities and Exposure page
  
         	[bookmark: pgfId-1134225]CAN-2003-0702
  
        
 
         
         	[bookmark: pgfId-1071124]mcafee
  
         	[bookmark: pgfId-1071126]McAfee page
  
         	[bookmark: pgfId-1134229]98574
  
        
 
         
         	[bookmark: pgfId-1133791]url
  
         	[bookmark: pgfId-1133793]Website reference
  
         	[bookmark: pgfId-1134231]www.example.com?exploit=14
  
        
 
         
         	[bookmark: pgfId-4412739]msb
  
         	[bookmark: pgfId-4412741]Microsoft security bulletin
  
         	[bookmark: pgfId-4412743]MS11-082
  
        
 
         
         	[bookmark: pgfId-4414735]nessus
  
         	[bookmark: pgfId-4414737]Nessus page
  
         	[bookmark: pgfId-4414739]10039
  
        
 
         
         	[bookmark: pgfId-4414729]secure-url
  
         	[bookmark: pgfId-4414731]Secure Website Reference (https://...)
  
         	[bookmark: pgfId-4414733]intranet/exploits/exploit=14
 [bookmark: pgfId-4415194]Note that you can use secure-url with any secure website.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1070984]To specify a reference using the rule editor, select reference from the Detection Options list, and enter a value in the corresponding field as follows:
 
      
      [bookmark: pgfId-1133772]id_system,id 
     
 
     [bookmark: pgfId-1133784]where id_system is the system being used as a prefix, and id is the Bugtraq ID, CVE number, Arachnids ID, or URL (without http://).
 
     [bookmark: pgfId-1071001]For example, to specify the authentication bypass vulnerability on Microsoft Commerce Server 2002 servers documented in Bugtraq ID 17134, enter the following in the reference field:
 
      
      [bookmark: pgfId-1134274]bugtraq,17134 
     
 
     [bookmark: pgfId-1134699]Note the following when adding references to a rule:
 
      
      	 [bookmark: pgfId-4414834]Do not use a space after the comma.
 
      	 [bookmark: pgfId-4414849]Do not use uppercase letters in the system ID.
 
     
 
     [bookmark: pgfId-4414815]See Constructing a Rule for more information about using the rule editor to build rules.
 
    
 
     
      [bookmark: pgfId-1093511][bookmark: 92509]Searching for Content Matches
 
     [bookmark: pgfId-4237978]License: Protection
 
     [bookmark: pgfId-4860326]Use the content keyword or the protected_content keyword to specify content that you want to detect in a packet. See the following sections for more information:
 
      
      	 [bookmark: pgfId-4860330]Using the content Keyword
 
      	 [bookmark: pgfId-4860334]Using the protected_content Keyword
 
      	 [bookmark: pgfId-4860338]Configuring Content Matching
 
     
 
    
 
     
      [bookmark: pgfId-4860340][bookmark: 30566]Using the conte[bookmark: marker-4867202]nt Keyword
 
     [bookmark: pgfId-4708496]When you use the content keyword, the rules engine searches the packet payload or stream for that string. For example, if you enter /bin/sh as the value for one of the content keywords, the rules engine searches the packet payload for the string /bin/sh.
 
     [bookmark: pgfId-1156554]Match content using either an ASCII string, hexadecimal content (binary byte code), or a combination of both. Surround hexadecimal content with pipe characters (|) in the keyword value. For example, you can mix hexadecimal content and ASCII content using something that looks like |90C8 C0FF FFFF|/bin/sh.
 
     [bookmark: pgfId-1058738]You can specify multiple content matches in a single rule. To do this, use additional instances of the content keyword. For each content match, you can indicate that content matches must be found in the packet payload or stream for the rule to trigger.
 
    
 
     
      [bookmark: pgfId-4860371][bookmark: 31807]Using the protecte[bookmark: marker-4867207]d_content Keyword
 
     [bookmark: pgfId-4860373]The protected_content keyword allows you to encode your search content string before configuring the rule argument. The original rule author uses a hash function (SHA-512, SHA-256, or MD5) to encode the string before configuring the keyword. 
 
     [bookmark: pgfId-4860374]When you use the protected_content keyword instead of the content keyword, there is no change to how the rules engine searches the packet payload or stream for that string and most of the keyword options function as expected. The following table summarizes the exceptions, where the protected_content keyword options differ from the content keyword options.
 
     [bookmark: pgfId-4860425]
 
      
       
        
        [bookmark: pgfId-4908793]Table 36-7 protected_content Option Exceptions 
 
        
        
         
         	 
           
           [bookmark: pgfId-4908797]Option 
          
  
         	 
           
           [bookmark: pgfId-4908799]Description 
          
  
        
 
         
         	[bookmark: pgfId-4908801]Hash Type
  
         	[bookmark: pgfId-4908803]New option for the protected_content rule keyword. For more information, see Hash Type.
  
        
 
         
         	[bookmark: pgfId-4908808]Case Insensitive
  
         	[bookmark: pgfId-4908810]Not supported
  
        
 
         
         	[bookmark: pgfId-4908812]Within
  
         	[bookmark: pgfId-4908814]Not supported
  
        
 
         
         	[bookmark: pgfId-4908816]Depth
  
         	[bookmark: pgfId-4908818]Not supported
  
        
 
         
         	[bookmark: pgfId-4908820]Length
  
         	[bookmark: pgfId-4908822]New option for the protected_content rule keyword. For more information, see Length.
  
        
 
         
         	[bookmark: pgfId-4908827]Use Fast Pattern Matcher
  
         	[bookmark: pgfId-4908829]Not supported
  
        
 
         
         	[bookmark: pgfId-4908831]Fast Pattern Matcher Only
  
         	[bookmark: pgfId-4908833]Not supported
  
        
 
         
         	[bookmark: pgfId-4908835]Fast Pattern Matcher Offset and Length
  
         	[bookmark: pgfId-4908837]Not supported
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4860429]Cisco recommends that you include at least one content keyword in rules that include a protected_content keyword to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Position the content keyword before the protected_content keyword in the rule. Note that the rules engine uses the fast pattern matcher when a rule includes at least one content keyword, regardless of whether you enable the content keyword Use Fast Pattern Matcher argument.
 
    
 
     
      [bookmark: pgfId-4860431][bookmark: 40906]Configuring Content Matching
 
     [bookmark: pgfId-4781756]You should almost always follow a content or protected_content keyword by modifiers that indicate where the content should be searched for, whether the search is case sensitive, and other options. See Constraining Content Matches for more information about modifiers to the content and protected_content keywords.
 
     [bookmark: pgfId-2267990]Note that all content matches must be true for the rule to trigger an event, that is, each content match has an AND relationship with the others.
 
     [bookmark: pgfId-4793014]Note also that, in an inline deployment, you can set up rules that match malicious content and then replace it with your own text string of equal length. See Replacing Content in Inline Deployments for more information.
 
     [bookmark: pgfId-4792999]To enter content to be matched: 
 
     [bookmark: pgfId-4240833]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1895918]Step 1 In the content field, type the content you want to find (for example, |90C8 C0FF FFFF|/bin/sh). 
 
     [bookmark: pgfId-1895755]If you want to search for any content that is not the specified content, select the Not check box. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2287036] 
      Caution You may invalidate your intrusion policy if you create a rule that includes only one 
      content keyword and that keyword has the 
      Not option selected. For more information, see 
      Not. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1895812]Step 2 Optionally, add additional keywords that modify the content keyword or add constraints for the keyword. For more information on other keywords, see Understanding Keywords and Arguments in Rules. 
 
     [bookmark: pgfId-4961565]For more information on constraining the content keyword, see Constraining Content Matches.
 
     [bookmark: pgfId-2012542]Step 3 Continue with creating or editing the rule. 
 
     [bookmark: pgfId-4961581]See Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774551]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860452]To enter protected content to be matched:
 
     [bookmark: pgfId-4860456]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4860458]Step 1 [bookmark: 15399]Using a SHA-512, SHA-256, or MD5 hash generator, encode the content you want to find (for example, run the string Sample1 through a SHA-512 hash generator).
 
     [bookmark: pgfId-4860459]The generator outputs a hash for your string.
 
     [bookmark: pgfId-4860464]Step 2 [bookmark: 24989]In the protected_content field, type the hash you generated in step 1 (for example, B20AABAF59605118593404BD42FE69BD8D6506EE7F1A71CE6BB470B1DF848C814BC5DBEC2081999F15691A71FAECA5FBA4A3F8B8AB56B7F04585DA6D73E5DD15).
 
     [bookmark: pgfId-4860465]If you want to search for any content that is not the specified content, select the Not check box. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-4860466] 
      Caution You may invalidate your intrusion policy if you create a rule that includes only one 
      protected_content keyword and that keyword has the 
      Not option selected. For more information, see 
      Not. 
       
       
 
      
 
     
 
     [bookmark: pgfId-4860473]Step 3 From the Hash Type drop-down list, select the hash function you used in step 1 (for example, SHA-512). Note that the number of bits in the hash entered in step 2 must match the hash type or the system does not save the rule. For more information, see Hash Type.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860483]Tip If you select the Cisco-set Default, the system assumes SHA-512 as the hash function.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860484]Step 4 Type a value in the required Length field. The value must correspond with the length of the original, unhashed string you want to find (for example, the string Sample1 from step 2 has the length 7). 
 
     [bookmark: pgfId-4967330]For more information, see Length.
 
     [bookmark: pgfId-4860491]Step 5 Type a value in either the Offset or Distance field. You cannot mix the Offset and Distance options within a single keyword configuration. 
 
     [bookmark: pgfId-4967341]For more information, see Using Search Location Options in the protected_content Keyword.
 
     [bookmark: pgfId-4860495]Step 6 Optionally, add additional constraining options that modify the protected_content keyword. 
 
     [bookmark: pgfId-4967348]For more information, see Constraining Content Matches.
 
     [bookmark: pgfId-4860499]Step 7 Optionally, add additional keywords that modify the protected_content keyword. 
 
     [bookmark: pgfId-4967355]For more information, see Understanding Keywords and Arguments in Rules.
 
     [bookmark: pgfId-4860510]Step 8 Continue with creating or editing the rule. 
 
     [bookmark: pgfId-4961597]See Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4860514]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3925176][bookmark: 14387]Constraining Content Matches
 
     [bookmark: pgfId-4237992]License: Protection
 
     [bookmark: pgfId-4710583]You can constrain the location and case-sensitivity of content searches with parameters that modify the content or protected_content keyword. Configure options that modify the content or protected_content keyword to specify the content for which you want to search.
 
     [bookmark: pgfId-3628685]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-3153151]Case Insensitive
 
      	 [bookmark: pgfId-4860537]Hash Type
 
      	 [bookmark: pgfId-3153159]Raw Data
 
      	 [bookmark: pgfId-3153219]Not
 
      	 [bookmark: pgfId-3153500]Search Location Options
 
      	 [bookmark: pgfId-3153179]HTTP Content Options
 
      	 [bookmark: pgfId-3153183]Use Fast Pattern Matcher
 
     
 
    
 
     
      [bookmark: pgfId-1225513][bookmark: marker-1225511][bookmark: 20752]Case Insensitive
 
     [bookmark: pgfId-4238013]License: Protection
 
      
       
     
 
     
 
     [bookmark: pgfId-4860542]Note This option is not supported when configuring the protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1225514]You can instruct the rules engine to ignore case when searching for content matches in ASCII strings. To make your search case-insensitive, check Case Insensitive when specifying a content search.
 
     [bookmark: pgfId-1896652]To specify Case Insensitive when doing a content search: 
 
     [bookmark: pgfId-4789116]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4789117]Step 1 Select Case Insensitive for the content keyword you are adding.
 
     [bookmark: pgfId-4789123]Step 2 Continue with creating or editing the rule. 
 
     [bookmark: pgfId-4961605]See Constraining Content Matches, Searching for Content Matches, Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4775520]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4860551] Hash Type [bookmark: 14612]
 
     [bookmark: pgfId-4860558]License: Protection
 
      
       
     
 
     
 
     [bookmark: pgfId-4860560]Note This option is only configurable with the protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860564]Use the Hash Type drop-down to identify the hash function you used to encode your search string. The system supports SHA-512, SHA-256, and MD5 hashing for protected_content search strings. If the length of your hashed content does not match the selected hash type, the system does not save the rule.
 
     [bookmark: pgfId-4860568]The system automatically selects the Cisco-set default value. When Default is selected, no specific hash function is written into the rule and the system assumes SHA-512 for the hash function.
 
     [bookmark: pgfId-4860569]To specify a hash function when doing a protected content search:
 
     
 
     [bookmark: pgfId-4860570]Step 1 From the Hash Type drop-down list, select Default, SHA-512, SHA-256, or MD5 as the hash for the protected_content keyword you are adding.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860574]Tip If you select the Cisco-set Default, the system assumes SHA-512 as the hash function. For more information, see Hash Type.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860581]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4860591]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4784028]  [bookmark: marker-2269760][bookmark: 41514]Raw Data 
 
     [bookmark: pgfId-4238026]License: Protection
 
     [bookmark: pgfId-2269763]The Raw Data option instructs the rules engine to analyze the original packet payload before analyzing the normalized payload data (decoded by a network analysis policy) and does not use an argument value. You can use this keyword when analyzing telnet traffic to check the telnet negotiation options in the payload before normalization.
 
     [bookmark: pgfId-3719338]You cannot use the Raw Data option together in the same content or protected_content keyword with any HTTP content option. See HTTP Content Options for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-3154699]Tip You can configure the HTTP Inspect preprocessor Client Flow Depth and Server Flow Depth options to determine whether raw data is inspected in HTTP traffic, and how much raw data is inspected. For more information, see Selecting Server-Level HTTP Normalization Options.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2269767]To analyze raw data: 
 
     [bookmark: pgfId-4788879]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4788880]Step 1 Select the Raw Data check box for the content or protected_content keyword you are adding.
 
     [bookmark: pgfId-4788886]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774571]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4722917][bookmark: 25080]Not
 
     [bookmark: pgfId-4722921]License: Protection
 
     [bookmark: pgfId-4722922]Select the Not option to search for content that does not match the specified content. If you create a rule that includes a content or protected_content keyword with the Not option selected, you must also include in the rule at least one other content or protected_content keyword without the Not option selected.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2278094] 
      Caution Do not create a rule that includes only one 
      content or 
      protected_content keyword if that keyword has the 
      Not option selected. You may invalidate your intrusion policy. 
       
       
 
      
 
     
 
     [bookmark: pgfId-3719356]For example, SMTP rule 1:2541:9 includes three content keywords, one of which has the Not option selected. A custom rule based on this rule would be invalid if you removed all of the content keywords except the one with the Not option selected. Adding such a rule to your intrusion policy could invalidate the policy.
 
     [bookmark: pgfId-3628838]To search for content that does not match the specified content: 
 
     [bookmark: pgfId-4240886]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-2271252]Step 1 Select the Not check box for the content or protected_content keyword you are adding.
 
      
       
     
 
     
 
     [bookmark: pgfId-3154827]Tip You cannot select the Not check box and the Use Fast Pattern Matcher check box with the same content keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2280813]Step 2 Include in the rule at least one other content or protected_content keyword that does not have the Not option selected.
 
     [bookmark: pgfId-2271255]Step 3 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774584]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4415460][bookmark: 14171]Search Location Options
 
     [bookmark: pgfId-4784733]License: Protection
 
     [bookmark: pgfId-4860632]You can use search location options to specify where to begin searching for the specified content and how far to continue searching. For details about each option, see:
 
      
      	 [bookmark: pgfId-4860636]Depth
 
      	 [bookmark: pgfId-4860640]Distance
 
      	 [bookmark: pgfId-4860644]Length
 
      	 [bookmark: pgfId-4860648]Offset
 
      	 [bookmark: pgfId-4860652]Within
 
     
 
     [bookmark: pgfId-4860653]For information about how to use search location options within the content or protected_content keyword, see: 
 
      
      	 [bookmark: pgfId-4860657]Using Search Location Options in the content Keyword
 
      	 [bookmark: pgfId-4860661]Using Search Location Options in the protected_content Keyword
 
     
 
     [bookmark: pgfId-4860664][bookmark: 33674]De[bookmark: marker-4860663]pth
 
      
       
     
 
     
 
     [bookmark: pgfId-4860665]Note This option is only supported when configuring the content keyword. For more information, see Using the content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860669]Specifies the maximum content search depth, in bytes, from the beginning of the offset value, or if no offset is configured, from the beginning of the packet payload.
 
     [bookmark: pgfId-4860670]For example, in a rule with a content value of cgi-bin/phf, and offset value of 3, and a depth value of 22, the rule starts searching for a match to the cgi-bin/phf string at byte 3, and stops after processing 22 bytes (byte 25) in packets that meet the parameters specified by the rule header.
 
     [bookmark: pgfId-4860671]You must specify a value that is greater than or equal to the length of the specified content, up to a maximum of 65535 bytes. You cannot specify a value of 0.
 
     [bookmark: pgfId-4860672]The default depth is to search to the end of the packet.
 
     [bookmark: pgfId-4871115][bookmark: 12104][bookmark: marker-4871114]Distance 
 
     [bookmark: pgfId-4871116]Instructs the rules engine to identify subsequent content matches that occur a specified number of bytes after the previous successful content match.
 
     [bookmark: pgfId-4860678]Because the distance counter starts at byte 0, specify one less than the number of bytes you want to move forward from the last successful content match. For example, if you specify 4, the search begins at the fifth byte.
 
     [bookmark: pgfId-4860679]You can specify a value of -65535 to 65535 bytes. If you specify a negative Distance value, the byte you start searching on may fall outside the beginning of a packet. Any calculations will take into account the bytes outside the packet, even though the search actually starts on the first byte in the packet. For example, if the current location in the packet is the fifth byte, and the next content rule option specifies a Distance value of -10 and a Within value of 20, the search starts at the beginning of the payload and the Within option is adjusted to 15. 
 
     [bookmark: pgfId-4860680]The default distance is 0, meaning the current location in the packet subsequent to the last content match.
 
     [bookmark: pgfId-4860683][bookmark: 19234]Length[bookmark: marker-4860682]
 
      
       
     
 
     
 
     [bookmark: pgfId-4860684]Note This option is only supported when configuring the protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4867320]The Length protected_content keyword option indicates the length, in bytes, of the unhashed search string. 
 
     [bookmark: pgfId-4867321]For example, if you used the content Sample1 to generate a secure hash, use 7 for the Length value. You must enter a value in this field.
 
     [bookmark: pgfId-4860696][bookmark: 91372]Off[bookmark: marker-4860695]set
 
     [bookmark: pgfId-4860697]Specifies in bytes where in the packet payload to start searching for content relative to the beginning of the packet payload. You can specify a value of-65535 to 65535 bytes.
 
     [bookmark: pgfId-4860698]Because the offset counter starts at byte 0, specify one less than the number of bytes you want to move forward from the beginning of the packet payload. For example, if you specify 7, the search begins at the eighth byte.
 
     [bookmark: pgfId-4860699]The default offset is 0, meaning the beginning of the packet. 
 
     [bookmark: pgfId-4860703][bookmark: 26084][bookmark: marker-4860701]Wit[bookmark: marker-4860702]hin
 
      
       
     
 
     
 
     [bookmark: pgfId-4871012]Note This option is only supported when configuring the content keyword. For more information, see Using the content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860708]The Within option indicates that, to trigger the rule, the next content match must occur within the specified number of bytes after the end of the last successful content match. For example, if you specify a Within value of 8, the next content match must occur within the next eight bytes of the packet payload or it does not meet the criteria that triggers the rule.
 
     [bookmark: pgfId-4860709]You can specify a value that is greater than or equal to the length of the specified content, up to a maximum of 65535 bytes.
 
     [bookmark: pgfId-4860710]The default for Within is to search to the end of the packet.
 
    
 
     
      [bookmark: pgfId-4860712][bookmark: 88153]Using Search Location Options in the content Keyword
 
     [bookmark: pgfId-4784735]You can use either of two content location pairs to specify where to begin searching for the specified content and how far to continue searching, as follows:
 
      
      	 [bookmark: pgfId-4415466]Use  Offset and  Depth together to search relative to the beginning of the packet payload.
 
      	 [bookmark: pgfId-4415467]Use  Distance and  Within together to search relative to the current search location.
 
     
 
     [bookmark: pgfId-4415468]When you specify only one of a pair, the default for the other option in the pair is assumed.
 
     [bookmark: pgfId-4416811]You cannot mix the Offset and Depth options with the Distance and Within options. For example, you cannot pair Offset and Within. You can use any number of location options in a rule.
 
     [bookmark: pgfId-4415469]When no location is specified, the defaults for Offset and Depth are assumed; that is, the content search starts at the beginning of the packet payload and continues to the end of the packet.
 
     [bookmark: pgfId-4415470]You can also use an existing byte_extract variable to specify the value for a location option. See Reading Packet Data into Keyword Arguments for more information.
 
     [bookmark: pgfId-4415500]To specify a search location value in a content keyword via the web interface: 
 
     [bookmark: pgfId-4415501]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4415502]Step 1 Type the value in the field for the content keyword you are adding. You have the following choices:
 
      
       
       	 [bookmark: pgfId-4415503] Offset 
 
       	 [bookmark: pgfId-4543300] Depth 
 
       	 [bookmark: pgfId-4543305] Distance 
 
       	 [bookmark: pgfId-4543321] Within 
 
      
 
     
 
     [bookmark: pgfId-4543322]You can use any number of location options in a rule.
 
     [bookmark: pgfId-4543325]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774610]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4860775][bookmark: 12160]Using Search Location Options in the protected_content Keyword
 
     [bookmark: pgfId-4860777]Use the required Length protected_content location option in combination with either the Offset or Distance location option to specify where to begin searching for the specified content and how far to continue searching, as follows:
 
      
      	 [bookmark: pgfId-4860778]Use  Length and  Offset together to search for the protected string relative to the beginning of the packet payload.
 
      	 [bookmark: pgfId-4860779]Use  Length and  Distance together to search for the protected string relative to the current search location.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4860780]Tip You cannot mix the Offset and Distance options within a single keyword configuration, but you can use any number of location options in a rule. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860781]When no location is specified, the defaults are assumed; that is, the content search starts at the beginning of the packet payload and continues to the end of the packet.
 
     [bookmark: pgfId-4860782]You can also use an existing byte_extract variable to specify the value for a location option. For more information, see Reading Packet Data into Keyword Arguments.
 
     [bookmark: pgfId-4860791]To specify a search location value in a protected_content keyword via the web interface: 
 
     [bookmark: pgfId-4860795]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4860796]Step 1 Type the value in the field for the protected_content keyword you are adding. You have the following choices:
 
      
      	 [bookmark: pgfId-4860797] Length (required)
 
       
       	 [bookmark: pgfId-4860798] Offset 
 
       	 [bookmark: pgfId-4860799] Distance 
 
      
 
     
 
     [bookmark: pgfId-4860800]You cannot mix the Offset and Distance options within a single protected_content keyword, but you can use any number of location options in a rule.
 
     [bookmark: pgfId-4860803]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4860814]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3587343][bookmark: 20004]HTTP Content Options
 
     [bookmark: pgfId-4238112]License: Protection
 
     [bookmark: pgfId-3719458]HTTP content or protected_content keyword options let you specify where to search for content matches within an HTTP message decoded by the HTTP Inspect preprocessor.
 
     [bookmark: pgfId-3719459]Two options search status fields in HTTP responses:
 
      
      	 [bookmark: pgfId-3719460] HTTP Status Code 
 
      	 [bookmark: pgfId-3719461] HTTP Status Message 
 
     
 
     [bookmark: pgfId-3719465]Note that although the rules engine searches the raw, unnormalized status fields, these options are listed here separately to simplify explanation below of the restrictions to consider when combining other raw HTTP fields and normalized HTTP fields.
 
     [bookmark: pgfId-3719466]Five options search normalized fields in HTTP requests, responses, or both, as appropriate (see HTTP Content Options for more information):
 
      
      	 [bookmark: pgfId-3719470] HTTP URI 
 
      	 [bookmark: pgfId-3719471] HTTP Method 
 
      	 [bookmark: pgfId-3719472] HTTP Header 
 
      	 [bookmark: pgfId-3719473] HTTP Cookie 
 
      	 [bookmark: pgfId-3719474] HTTP Client Body 
 
     
 
     [bookmark: pgfId-3719475]Three options search raw (unnormalized) non-status fields in HTTP requests, responses, or both, as appropriate (see HTTP Content Options for more information):
 
      
      	 [bookmark: pgfId-3719479] HTTP Raw URI 
 
      	 [bookmark: pgfId-3719480] HTTP Raw Header 
 
      	 [bookmark: pgfId-3719481] HTTP Raw Cookie 
 
     
 
     [bookmark: pgfId-3719482]Use the following guidelines when selecting HTTP content options:
 
      
      	 [bookmark: pgfId-3719483]HTTP  content options apply only to TCP traffic. 
 
      	 [bookmark: pgfId-3719484]To avoid a negative impact on performance, select only those parts of the message where the specified content might appear.
 
     
 
     [bookmark: pgfId-3719485]For example, when traffic is likely to include large cookies such as those in shopping cart messages, you might search for the specified content in the HTTP header but not in HTTP cookies.
 
      
      	 [bookmark: pgfId-3719487]To take advantage of HTTP Inspect preprocessor normalization, and to improve performance, any HTTP-related rule you create should at a minimum include at least one  content or  protected_content keyword with an  HTTP URI ,  HTTP Method ,  HTTP Header , or  HTTP Client Body option selected.
 
      	 [bookmark: pgfId-3719488]You cannot use the  replace keyword in conjunction with HTTP  content or  protected_content keyword options.
 
     
 
     [bookmark: pgfId-3719489]You can specify a single normalized HTTP option or status field, or use normalized HTTP options and status fields in any combination to target a content area to match. However, note the following restrictions when using HTTP field options:
 
      
      	 [bookmark: pgfId-3719490]You cannot use the  Raw Data option together in the same  content or  protected_content keyword with any HTTP option.
 
      	 [bookmark: pgfId-3719491]You cannot use a raw HTTP field option ( HTTP Raw URI ,  HTTP Raw Header , or  HTTP Raw Cookie ) together in the same  content or  protected_content keyword with its normalized counterpart ( HTTP URI ,  HTTP Header , or  HTTP Cookie , respectively).
 
      	 [bookmark: pgfId-3719492]You cannot select  Use Fast Pattern Matcher in combination with one or more of the following HTTP field options:
 
     
 
     [bookmark: pgfId-3719493]HTTP Raw URI, HTTP Raw Header, HTTP Raw Cookie, HTTP Cookie, HTTP Method, HTTP Status Message, or HTTP Status Code
 
     [bookmark: pgfId-3719494]However, you can include the options above in a content or protected_content keyword that also uses the fast pattern matcher to search one of the following normalized fields:
 
     [bookmark: pgfId-4226542]HTTP URI, HTTP Header, or HTTP Client Body
 
     [bookmark: pgfId-4226543]For example, if you select HTTP Cookie, HTTP Header, and Use Fast Pattern Matcher, the rules engine searches for content in both the HTTP cookie and the HTTP header, but the fast pattern matcher is applied only to the HTTP header, not to the HTTP cookie.
 
      
      	 [bookmark: pgfId-4226491]When you combine restricted and unrestricted options, the fast pattern matcher searches only the unrestricted fields you specify to test whether to pass the rule to the rule editor for complete evaluation, including evaluation of the restricted fields. See Use Fast Pattern Matcher for more information.
 
     
 
     [bookmark: pgfId-4549704]The above restrictions are reflected in the description of each option in the following list describing the HTTP content and protected_content keyword options.
 
     [bookmark: pgfId-4543419]HTTP U[bookmark: marker-4545055]RI
 
     [bookmark: pgfId-4543508]Select this option to search for content matches in the normalized request URI field.
 
     [bookmark: pgfId-4543556]Note that you cannot use this option in combination with the pcre keyword HTTP URI (U) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-4543568]Note A pipelined HTTP request packet contains multiple URIs. When HTTP URI is selected and the rules engine detects a pipelined HTTP request packet, the rules engine searches all URIs in the packet for a content match.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4545072]HTTP Ra[bookmark: marker-4545071]w URI
 
     [bookmark: pgfId-4545101]Select this option to search for content matches in the normalized request URI field.
 
     [bookmark: pgfId-4545102]Note that you cannot use this option in combination with the pcre keyword HTTP URI (U) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-4545109]Note A pipelined HTTP request packet contains multiple URIs. When HTTP URI is selected and the rules engine detects a pipelined HTTP request packet, the rules engine searches all URIs in the packet for a content match.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4543553]HTTP Me[bookmark: marker-4545414]thod
 
     [bookmark: pgfId-4545431]Select this option to search for content matches in the request method field, which identifies the action such as GET and POST to take on the resource identified in the URI.
 
     [bookmark: pgfId-4545453]HTTP He[bookmark: marker-4545461]ader
 
     [bookmark: pgfId-4545485]Select this option to search for content matches in the normalized header field, except for cookies, in HTTP requests; also in responses when the HTTP Inspect preprocessor Inspect HTTP Responses option is enabled.
 
     [bookmark: pgfId-4545486]Note that you cannot use this option in combination with the pcre keyword HTTP header (H) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
     [bookmark: pgfId-4545543]HTTP Ra[bookmark: marker-4545568]w Header
 
     [bookmark: pgfId-4545598]Select this option to search for content matches in the raw header field, except for cookies, in HTTP requests; also in responses when the HTTP Inspect preprocessor Inspect HTTP Responses option is enabled.
 
     [bookmark: pgfId-4545599]Note that you cannot use this option in combination with the pcre keyword HTTP raw header (D) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
     [bookmark: pgfId-4545632]HTTP Co[bookmark: marker-4545631]okie
 
     [bookmark: pgfId-4545650]Select this option to search for content matches in any cookie identified in a normalized HTTP client request header; also in response set-cookie data when the HTTP Inspect preprocessor Inspect HTTP Responses option is enabled. Note that the system treats cookies included in the message body as body content.
 
     [bookmark: pgfId-4883768]You must enable the HTTP Inspect preprocessor Inspect HTTP Cookies option to search only the cookie for a match; otherwise, the rules engine searches the entire header, including the cookie. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4883772]Note the following:
 
     [bookmark: pgfId-4545663] – You cannot use this option in combination with the pcre keyword HTTP cookie (C) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
     [bookmark: pgfId-4545667] – The Cookie: and Set-Cookie: header names, leading spaces on the header line, and the CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
     [bookmark: pgfId-4545974]HTTP Ra[bookmark: marker-4545973]w Cookie
 
     [bookmark: pgfId-4546004]Select this option to search for content matches in any cookie identified in a raw HTTP client request header; also in response set-cookie data when the HTTP Inspect preprocessor Inspect HTTP Responses option is enabled; note that the system treats cookies included in the message body as body content.
 
     [bookmark: pgfId-4546005]You must enable the HTTP Inspect preprocessor Inspect HTTP Cookies option to search only the cookie for a match; otherwise, the rules engine searches the entire header, including the cookie. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4546009]Note the following:
 
     [bookmark: pgfId-4546017] – You cannot use this option in combination with the pcre keyword HTTP raw cookie (K) option to search the same content. See the Snort-Specific Post Regular Expression Modifiers table for more information.
 
     [bookmark: pgfId-4546021] – The Cookie: and Set-Cookie: header names, leading spaces on the header line, and the CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
     [bookmark: pgfId-4546045]HTTP Clie[bookmark: marker-4546044]nt Body
 
     [bookmark: pgfId-4546073]Select this option to search for content matches in the message body in an HTTP client request.
 
     [bookmark: pgfId-4546074]Note that for this option to function, you must specify a value of 0 to 65535 for the HTTP Inspect preprocessor HTTP Client Body Extraction Depth option. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4546094]HTTP Stat[bookmark: marker-4546093]us Code
 
     [bookmark: pgfId-4546114]Select this option to search for content matches in the 3-digit status code in an HTTP response.
 
     [bookmark: pgfId-4546115]You must enable the HTTP Inspect preprocessor Inspect HTTP Responses option for this option to return a match. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4545623]HTTP Sta[bookmark: marker-4546430]tus Message
 
     [bookmark: pgfId-4546461]Select this option to search for content matches in the textual description that accompanies the status code in an HTTP response.
 
     [bookmark: pgfId-4546462]You must enable the HTTP Inspect preprocessor Inspect HTTP Responses option for this option to return a match. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-3719654]To specify an HTTP content option when doing a content search of TCP traffic: 
 
     [bookmark: pgfId-4240952]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-3719656]Step 1 Optionally, to take advantage of HTTP Inspect preprocessor normalization, and to improve performance, select:
 
      
       
       	 [bookmark: pgfId-4928855]at least one from among the  HTTP URI ,  HTTP Raw URI ,  HTTP Method ,  HTTP Header ,  HTTP Raw Header , or  HTTP Client Body options for the  content or  protected_content keyword you are adding
 
       	 [bookmark: pgfId-4928866]the  HTTP Cookie or  HTTP Raw Cookie  option
 
      
 
     
 
     [bookmark: pgfId-3719660]Step 2 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Matches, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774671]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3589405][bookmark: 38097]Use Fa[bookmark: marker-3587952]st Pattern Matcher
 
     [bookmark: pgfId-4238125]License: Protection
 
      
       
     
 
     
 
     [bookmark: pgfId-4860882]Note These options are not supported when configuring the protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3719708]The fast pattern matcher quickly determines which rules to evaluate before passing a packet to the rules engine. This initial determination improves performance by significantly reducing the number of rules used in packet evaluation.
 
     [bookmark: pgfId-3719709]By default, the fast pattern matcher searches packets for the longest content specified in a rule; this is to eliminate as much as possible needless evaluation of a rule. Consider the following example rule fragment:
 
      
      [bookmark: pgfId-3719710]alert tcp any any -> any 80 (msg:"Exploit"; content:"GET";
http_method; nocase; content:"/exploit.cgi"; http_uri;
nocase;) 
     
 
     [bookmark: pgfId-3719711]Almost all HTTP client requests contain the content GET, but few will contain the content /exploit.cgi. Using GET as the fast pattern content would cause the rules engine to evaluate this rule in most cases and would rarely result in a match. However, most client GET requests would not be evaluated using /exploit.cgi, thus increasing performance.
 
     [bookmark: pgfId-3719712]The rules engine evaluates the packet against the rule only when the fast pattern matcher detects the specified content. For example, if one content keyword in a rule specifies the content short, another specifies longer, and a third specifies longest, the fast pattern matcher will use the content longest and the rule will be evaluated only if the rules engine finds longest in the payload.
 
     [bookmark: pgfId-3719713]You can use the Use Fast Pattern Matcher option to specify a shorter search pattern for the fast pattern matcher to use. Ideally, the pattern you specify is less likely to be found in the packet than the longest pattern and, therefore, more specifically identifies the targeted exploit.
 
     [bookmark: pgfId-3719714]Note the following restrictions when selecting Use Fast Pattern Matcher and other options in the same content keyword:
 
      
      	 [bookmark: pgfId-3719715]You can specify  Use Fast Pattern Matcher only one time per rule.
 
      	 [bookmark: pgfId-3719716]You cannot use  Distance ,  Within ,  Offset , or  Depth when you select  Use Fast Pattern Matcher in combination with  Not .
 
      	 [bookmark: pgfId-4226991]You cannot select Use Fast Pattern Matcher in combination with any of the following HTTP field options:
 
     
 
     [bookmark: pgfId-4226992]HTTP Raw URI, HTTP Raw Header, HTTP Raw Cookie, HTTP Cookie, HTTP Method, HTTP Status Message, or HTTP Status Code
 
     [bookmark: pgfId-4227006]However, you can include the options above in a content keyword that also uses the fast pattern matcher to search one of the following normalized fields:
 
     [bookmark: pgfId-4227007]HTTP URI, HTTP Header, or HTTP Client Body
 
     [bookmark: pgfId-4227008]For example, if you select HTTP Cookie, HTTP Header, and Use Fast Pattern Matcher, the rules engine searches for content in both the HTTP cookie and the HTTP header, but the fast pattern matcher is applied only to the HTTP header, not to the HTTP cookie.
 
     [bookmark: pgfId-4226773]Note that you cannot use a raw HTTP field option (HTTP Raw URI, HTTP Raw Header, or HTTP Raw Cookie) together in the same content keyword with its normalized counterpart (HTTP URI, HTTP Header, or HTTP Cookie, respectively). See HTTP Content Options for more information.
 
     [bookmark: pgfId-3719725]When you combine restricted and unrestricted options, the fast pattern matcher searches only the unrestricted fields you specify to test whether to pass the packet to the rules engine for complete evaluation, including evaluation of the restricted fields.
 
      
      	 [bookmark: pgfId-3719726]Optionally, when you select  Use Fast Pattern Matcher you can also select  Fast Pattern Matcher Only or  Fast Pattern Matcher Offset and Length , but not both.
 
      	 [bookmark: pgfId-4080082]You cannot use the fast pattern matcher when inspecting Base64 data; see Decoding and Inspecting Base64 Data for more information.
 
     
 
     [bookmark: pgfId-3719727]Using the Fast Pattern Matcher Only
 
     [bookmark: pgfId-3719728]The Fast Pattern Matcher Only option allows you to use the content keyword only as a fast pattern matcher option and not as a rule option. You can use this option to conserve resources when rules engine evaluation of the specified content is not necessary. For example, consider a case where a rule requires only that the content 12345 be anywhere in the payload. When the fast pattern matcher detects the pattern, the packet can be evaluated against additional keywords in the rule. There is no need for the rules engine to reevaluate the packet to determine if it includes the pattern 12345.
 
     [bookmark: pgfId-3719729]You would not use this option when the rule contains other conditions relative to the specified content. For example, you would not use this option to search for the content 1234 if another rule condition sought to determine if abcd occurs before 1234. In this case, the rules engine could not determine the relative location because specifying Fast Pattern Matcher Only instructs the rules engine not to search for the specified content.
 
     [bookmark: pgfId-3719730]Note the following conditions when using this option:
 
      
      	 [bookmark: pgfId-4789892]The specified content is location-independent; that is, it may occur anywhere in the payload; thus, you cannot use positional options ( Distance ,  Within ,  Offset ,  Depth , or  Fast Pattern Matcher Offset and Length ).
 
      	 [bookmark: pgfId-3719732]You cannot use this option in combination with  Not .
 
      	 [bookmark: pgfId-3719733]You cannot use this option in combination with  Fast Pattern Matcher Offset and Length .
 
      	 [bookmark: pgfId-3719734]The specified content will be treated as case-insensitive, because all patterns are inserted into the fast pattern matcher in a case-insensitive manner; this is handled automatically, so it is not necessary to select  Case Insensitive when you select this option.
 
      	 [bookmark: pgfId-4509552]You should not immediately follow a  content keyword that uses the  Fast Pattern Matcher Only  option with the following keywords, which set the search location relative to the current search location:
 
       
       	 [bookmark: pgfId-4510098] isdataat 
 
       	 [bookmark: pgfId-4510099] pcre 
 
       	 [bookmark: pgfId-4510100] content when  Distance or  Within is selected
 
       	 [bookmark: pgfId-4510010] content when  HTTP URI is selected
 
       	 [bookmark: pgfId-4510020] asn1 
 
       	 [bookmark: pgfId-4510026] byte_jump 
 
       	 [bookmark: pgfId-4510037] byte_test 
 
       	 [bookmark: pgfId-4510048] byte_extract 
 
       	 [bookmark: pgfId-4510062] base64_decode 
 
      
 
     
 
     [bookmark: pgfId-3719736][bookmark: 92798]Specifying Fast Pattern Matcher Offset and Length
 
     [bookmark: pgfId-3719737]The Fast Pattern Matcher Offset and Length option allows you to specify a portion of the content to search. This can reduce memory consumption in cases where the pattern is very long and only a portion of the pattern is sufficient to identify the rule as a likely match. When a rule is selected by the fast pattern matcher, the entire pattern is evaluated against the rule. 
 
     [bookmark: pgfId-3719738]You determine the portion for the fast pattern matcher to use by specifying in bytes where to begin the search (offset) and how far into the content (length) to search, using the syntax:
 
      
      [bookmark: pgfId-3719739]offset,length 
     
 
     [bookmark: pgfId-3719740]For example, for the content:
 
      
      [bookmark: pgfId-3719741]1234567 
     
 
     [bookmark: pgfId-3719742]if you specify the number of offset and length bytes as:
 
      
      [bookmark: pgfId-3719743]1,5 
     
 
     [bookmark: pgfId-3719744]the fast pattern matcher searches only for the content 23456.
 
     [bookmark: pgfId-3719745]Note that you cannot use this option together with Fast Pattern Matcher Only.
 
     [bookmark: pgfId-3719746]To specify the content searched for by the fast pattern matcher:
 
     [bookmark: pgfId-4240965]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-3719748]Step 1 Select Use Fast Pattern Matcher for the content keyword you are adding.
 
     [bookmark: pgfId-3719749]Step 2 Optionally, select Fast Pattern Matcher Only to determine without rules engine evaluation if the specified pattern exists in the packet. 
 
     [bookmark: pgfId-3719750]Evaluation proceeds only if the fast pattern matcher detects the specified content.
 
     [bookmark: pgfId-3719751]Step 3 Optionally, specify in Fast Pattern Matcher Offset and Length a portion of the pattern to search for the content using the syntax:
 
      
      [bookmark: pgfId-3719752]offset,length 
     
 
     [bookmark: pgfId-3719753]where offset specifies how many bytes from the beginning of the content to begin the search, and length specifies the number of bytes to continue.
 
     [bookmark: pgfId-3719757]Step 4 Continue with creating or editing the rule. See Constraining Content Matches, Searching for Content Using PCRE, Writing New Rules, or Modifying Existing Rules for more information.
 
     [bookmark: pgfId-4774682]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4002833][bookmark: 27147]Replac[bookmark: marker-4002832]ing Content in Inline Deployments
 
     [bookmark: pgfId-4238138]License: Protection
 
     [bookmark: pgfId-4239444]You can use the replace keyword in an inline deployment to replace specified content.
 
      
       
     
 
     
 
     [bookmark: pgfId-4239445]Note You cannot use the replace keyword to replace content in SSL traffic detected by the Cisco SSL Appliance. The original encrypted data, not the replacement data, will be transmitted. See the Cisco SSL Appliance Administration and Deployment Guide for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4002842]To use the replace keyword, construct a custom standard text rule that uses the content keyword to look for a specific string. Then use the replace keyword to specify a string to replace the content. The replace value and content value must be the same length.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860890]Note You cannot use the replace keyword to replace hashed content in a protected_content keyword. For more information, see Using the protected_content Keyword.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4002843]Optionally, you can enclose the replacement string in quotation marks for backward compatibility with previous FireSIGHT System software versions. If you do not include quotation marks, they are added to the rule automatically so the rule is syntactically correct. To include a leading or trailing quotation mark as part of the replacement text, you must use a backslash to escape it, as shown in the following example:
 
      
      [bookmark: pgfId-4002847]"replacement text plus \"quotation\" marks"" 
     
 
     [bookmark: pgfId-4002848]A rule can contain multiple replace keywords, but only one per content keyword. Only the first instance of the content found by the rule is replaced.
 
     [bookmark: pgfId-4002849]The following explain example uses of the replace keyword:
 
      
      	 [bookmark: pgfId-4002853]If the system detects an incoming packet that contains an exploit, you can replace the malicious string with a harmless one. Sometimes this technique is more successful than simply dropping the offending packet. In some attack scenarios, the attacker simply resends the dropped packet until it bypasses your network defenses or floods your network. By substituting one string for another rather than dropping the packet, you may trick the attacker into believing that the attack was launched against a target that was not vulnerable.
 
      	 [bookmark: pgfId-4002854]If you are concerned about reconnaissance attacks that try to learn whether you are running a vulnerable version of, for example, a web server, then you can detect the outgoing packet and replace the banner with your own text.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4002855]Note Make sure that you set the rule state to Generate Events in the inline intrusion policy where you want to use the replace rule; setting the rule to Drop and Generate events would cause the packet to drop, which would prevent replacing the content.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4002859]As part of the string replacement process, the system automatically updates the packet checksums so that the destination host can receive the packet without error.
 
     [bookmark: pgfId-4002860]Note that you cannot use the replace keyword in combination with HTTP request message content keyword options. See Searching for Content Matches and HTTP Content Options for more information.
 
     [bookmark: pgfId-4002867]To replace content in an inline deployment:
 
     [bookmark: pgfId-4240980]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4002869]Step 1 On the Create Rule page, select content in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4002870]The content keyword appears.
 
     [bookmark: pgfId-4002876]Step 2 Specify the content you want to detect in the content field and, optionally, select any applicable arguments. Note that you cannot use the HTTP request message content keyword options with the replace keyword.
 
     [bookmark: pgfId-4002877]Step 3 Select replace in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4002878]The replace keyword appears beneath the content keyword.
 
     [bookmark: pgfId-4002883]Step 4 Specify the replacement string for the specified content in the replace: field.
 
     [bookmark: pgfId-4775542]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3975331][bookmark: 92371]Using Byte_Jump and Byte_Test
 
     [bookmark: pgfId-4238151]License: Protection
 
     [bookmark: pgfId-1231501]You can use byte_jump and byte_test to calculate where in a packet the rules engine should begin testing for a data match, and which bytes it should evaluate.
 
     [bookmark: pgfId-3300270]You can also use the byte_jump and byte_test DCE/RPC argument to tailor either keyword for traffic processed by the DCE/RPC preprocessor. When you use the DCE/RPC argument, you can also use byte_jump and byte_test in conjunction with other specific DCE/RPC keywords. See Decoding DCE/RPC Traffic and DCE/RPC Keywords for more information.
 
     [bookmark: pgfId-1231999]See the following sections for more information:
 
      
      	 [bookmark: pgfId-1232004]byte_jump
 
      	 [bookmark: pgfId-4963720]byte_test
 
     
 
    
 
     
      [bookmark: pgfId-4963722][bookmark: marker-4963736]byte_jump[bookmark: 19434] 
 
     [bookmark: pgfId-4963729]License: Protection
 
     [bookmark: pgfId-1691314]The byte_jump keyword calculates the number of bytes defined in a specified byte segment, and then skips that number of bytes within the packet, either forward from the end of the specified byte segment, or from the beginning of the packet payload, depending on the options you specify. This is useful in packets where a specific segment of bytes describe the number of bytes included in variable data within the packet.
 
      
       
        
        [bookmark: pgfId-1487082]Table 36-8 [bookmark: 43924]Required byte_jump Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1487086]Argument 
          
  
         	 
           
           [bookmark: pgfId-1487088]Description 
          
  
        
 
         
         	[bookmark: pgfId-1487090]Bytes
  
         	[bookmark: pgfId-1487092]The number of bytes to calculate from the packet.
  
        
 
         
         	[bookmark: pgfId-1487094]Offset
  
         	[bookmark: pgfId-4003660]The number of bytes into the payload to start processing. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to jump forward from the beginning of the packet payload or the last successful content match. 
 [bookmark: pgfId-3925717]You can also use an existing byte_extract variable to specify the value for this argument. See Reading Packet Data into Keyword Arguments for more information.
  
        
 
        
      
 
     
 
      
       
        
        [bookmark: pgfId-4390439]Table 36-9 [bookmark: 91568]Additional Optional byte_jump Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4390443]Argument 
          
  
         	 
           
           [bookmark: pgfId-4390445]Description 
          
  
        
 
         
         	[bookmark: pgfId-4390447]Relative
  
         	[bookmark: pgfId-4390449]Makes the offset relative to the last pattern found in the last successful content match.
  
        
 
         
         	[bookmark: pgfId-4390451]Align
  
         	[bookmark: pgfId-4390453]Rounds the number of converted bytes up to the next 32-bit boundary.
  
        
 
         
         	[bookmark: pgfId-4390455]Multiplier
  
         	[bookmark: pgfId-4390457]Indicates the value by which the rules engine should multiply the byte_jump value obtained from the packet to get the final byte_jump value.
 [bookmark: pgfId-4390458]That is, instead of skipping the number of bytes defined in a specified byte segment, the rules engine skips that number of bytes multiplied by an integer you specify with the Multiplier argument.
  
        
 
         
         	[bookmark: pgfId-4390460]Post Jump Offset
  
         	[bookmark: pgfId-4390462]The number of bytes -63535 through 63535 to skip forward or backward after applying other byte_jump arguments. A positive value skips forward and a negative value skips backward. Leave the field blank or enter 0 to disable.
 [bookmark: pgfId-4390465]See the DCE/RPC argument in the Endianness Arguments table for byte_jump arguments that do not apply when you select the DCE/RPC argument.
  
        
 
         
         	[bookmark: pgfId-4390468]From Beginning
  
         	[bookmark: pgfId-4390470]Indicates that the rules engine should skip the specified number of bytes in the payload starting from the beginning of the packet payload, rather than from the end of the byte segment that specifies the number of bytes to skip.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4390472]You can specify only one of DCE/RPC, Endian, or Number Type.
 
      
       
        
        [bookmark: pgfId-1447558]Table 36-10 [bookmark: 96362]Endianness Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231536]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231538]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231540]Big Endian
  
         	[bookmark: pgfId-1231542]Processes data in big endian byte order, which is the default network byte order.
  
        
 
         
         	[bookmark: pgfId-1231544]Little Endian
  
         	[bookmark: pgfId-1231546]Processes data in little endian byte order.
  
        
 
         
         	[bookmark: pgfId-3300357]DCE/RPC
  
         	[bookmark: pgfId-3300359]Specifies a byte_jump keyword for traffic processed by the DCE/RPC preprocessor. See Decoding DCE/RPC Traffic for more information.
 [bookmark: pgfId-3300363]The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type, Endian, and From Beginning arguments do not apply.
 [bookmark: pgfId-3300364]When you enable this argument, you can also use byte_jump in conjunction with other specific DCE/RPC keywords. See DCE/RPC Keywords for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231548]Define how the system views string data in a packet by using one of the arguments in the following table.
 
     [bookmark: pgfId-1231570]
 
      
       
        
        [bookmark: pgfId-1447562]Table 36-11 [bookmark: 13353]Number Type Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231551]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231553]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231559]Hexadecimal String
  
         	[bookmark: pgfId-1231561]Represents converted string data in hexadecimal format.
  
        
 
         
         	[bookmark: pgfId-1231563]Decimal String
  
         	[bookmark: pgfId-1231565]Represents converted string data in decimal format.
  
        
 
         
         	[bookmark: pgfId-1231567]Octal String
  
         	[bookmark: pgfId-1231569]Represents converted string data in octal format.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231579]For example, if the values you set for byte_jump are as follows:
 
      
      	 [bookmark: pgfId-1231580]Bytes = 4
 
      	 [bookmark: pgfId-1557505]Offset = 12 
 
      	 [bookmark: pgfId-1557508]Relative enabled
 
      	 [bookmark: pgfId-1557509]Align enabled
 
     
 
     [bookmark: pgfId-1684345]the rules engine calculates the number described in the four bytes that appear 13 bytes after the last successful content match, and skips ahead that number of bytes in the packet. For instance, if the four calculated bytes in a specific packet were 00 00 00 1F, the rules engine would convert this to 31. Because align is specified (which instructs the engine to move to the next 32-bit boundary), the rules engine skips ahead 32 bytes in the packet.
 
     [bookmark: pgfId-1706660]Alternately, if the values you set for byte_jump are as follows:
 
      
      	 [bookmark: pgfId-1706661]Bytes = 4
 
      	 [bookmark: pgfId-1706662]Offset = 12 
 
      	 [bookmark: pgfId-1706663]From Beginning enabled
 
      	 [bookmark: pgfId-1706664]Multiplier = 2
 
     
 
     [bookmark: pgfId-1706665]the rules engine calculates the number described in the four bytes that appear 13 bytes after the beginning of the packet. Then, the engine multiplies that number by two to obtain the total number of bytes to skip. For instance, if the four calculated bytes in a specific packet were 00 00 00 1F, the rules engine would convert this to 31, then multiply it by two to get 62. Because From Beginning is enabled, the rules engine skips the first 63 bytes in the packet.
 
     [bookmark: pgfId-3890173]To use byte_jump:
 
     [bookmark: pgfId-4241018]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-3890175]Step 1 Select byte_jump in the drop-down list and click Add Option. 
 
     [bookmark: pgfId-3965071]The byte_jump section appears beneath the last keyword you selected.
 
     [bookmark: pgfId-4775593]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1231624]  [bookmark: marker-1231622][bookmark: 73840]byte_test 
 
     [bookmark: pgfId-4238222]License: Protection
 
     [bookmark: pgfId-3567911]The byte_test keyword calculates the number of bytes in a specified byte segment and compares them, according to the operator and value you specify.
 
      
       
        
        [bookmark: pgfId-1447566]Table 36-12 [bookmark: 81640]Required byte_test Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231629]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231631]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231633]Bytes
  
         	[bookmark: pgfId-1231635]The number of bytes to calculate from the packet. You can specify 1 to 10 bytes.
  
        
 
         
         	[bookmark: pgfId-1231637]Operator and Value
  
         	[bookmark: pgfId-1231639]Compares the specified value to <, >, =, !, &, ^, !>, !<, !=, !&, or !^. 
 [bookmark: pgfId-4003634]For example, if you specify !1024, byte_test would convert the specified number, and if it did not equal 1024, it would generate an event (if all other keyword parameters matched).
 [bookmark: pgfId-1506186]Note that ! and != are equivalent.
 [bookmark: pgfId-4046872]You can also use an existing byte_extract variable to specify the value for this argument. See Reading Packet Data into Keyword Arguments for more information.
  
        
 
         
         	[bookmark: pgfId-1231641]Offset
  
         	[bookmark: pgfId-4003643]The number of bytes into the payload to start processing. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to count forward from the beginning of the packet payload or the last successful content match. 
 [bookmark: pgfId-1231643]You can also use an existing byte_extract variable to specify the value for this argument. See Reading Packet Data into Keyword Arguments for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231645]You can further define how the system uses byte_test arguments with the arguments described in the following table.
 
     [bookmark: pgfId-1231659]
 
      
       
        
        [bookmark: pgfId-1447570]Table 36-13 Additional Optional [bookmark: 21162]byte_test Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231648]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231650]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231652]Relative
  
         	[bookmark: pgfId-1231654]Makes the offset relative to the last successful pattern match.
  
        
 
         
         	[bookmark: pgfId-1231656]Align
  
         	[bookmark: pgfId-1231658]Rounds the number of converted bytes up to the next 32-bit boundary.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4227361]You can specify only one of DCE/RPC, Endian, or Number Type.
 
      
       
        
        [bookmark: pgfId-1447574]Table 36-14 Endianness [bookmark: 54171]byte_test Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231663]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231665]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231667]Big Endian
  
         	[bookmark: pgfId-1231669]Processes data in big endian byte order, which is the default network byte order.
  
        
 
         
         	[bookmark: pgfId-1231671]Little Endian
  
         	[bookmark: pgfId-1231673]Processes data in little endian byte order.
  
        
 
         
         	[bookmark: pgfId-3300665]DCE/RPC
  
         	[bookmark: pgfId-3300667]Specifies a byte_test keyword for traffic processed by the DCE/RPC preprocessor. See Decoding DCE/RPC Traffic for more information.
 [bookmark: pgfId-3300671]The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type and Endian argument do not apply.
 [bookmark: pgfId-3300672]When you enable this argument, you can also use byte_test in conjunction with other specific DCE/RPC keywords. See DCE/RPC Keywords for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231675]You can define how the system views string data in a packet by using one of the arguments in the following table.
 
     [bookmark: pgfId-1231697]
 
      
       
        
        [bookmark: pgfId-1447610]Table 36-15 Number Type [bookmark: 19283]byte-test Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1231678]Argument 
          
  
         	 
           
           [bookmark: pgfId-1231680]Description 
          
  
        
 
         
         	[bookmark: pgfId-1231686]Hexadecimal String
  
         	[bookmark: pgfId-1231688]Represents converted string data in hexadecimal format.
  
        
 
         
         	[bookmark: pgfId-1231690]Decimal String
  
         	[bookmark: pgfId-1231692]Represents converted string data in decimal format.
  
        
 
         
         	[bookmark: pgfId-1231694]Octal String
  
         	[bookmark: pgfId-1231696]Represents converted string data in octal format.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1231708]For example, if the value for byte_test is specified as the following:
 
      
      	 [bookmark: pgfId-1557893]Bytes = 4
 
      	 [bookmark: pgfId-1557935]Operator and Value > 128
 
      	 [bookmark: pgfId-1557936]Offset = 8
 
      	 [bookmark: pgfId-1557939]Relative enabled
 
     
 
     [bookmark: pgfId-1231710]the rules engine calculates the number described in the four bytes that appear 9 bytes away from (relative to) the last successful content match, and, if the calculated number is larger than 128 bytes, the rule is triggered. 
 
     [bookmark: pgfId-3889789]To use byte_test:
 
     [bookmark: pgfId-4241041]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-3889791]Step 1 On the Create Rule page, select byte_test in the drop-down list and click Add Option.
 
     [bookmark: pgfId-3965110]The byte_test section appears beneath the last keyword you selected.
 
     [bookmark: pgfId-4775666]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2925147][bookmark: 11765]Searching for Content Us[bookmark: marker-3099234]ing PCRE[bookmark: marker-2925144][bookmark: marker-2925145][bookmark: marker-2925146]
 
     [bookmark: pgfId-4238241]License: Protection
 
     [bookmark: pgfId-1219458]The pcre keyword allows you to use Perl-compatible regular expressions (PCRE) to inspect packet payloads for specified content. You can use PCRE to avoid writing multiple rules to match slight variations of the same content. 
 
     [bookmark: pgfId-1219459]Regular expressions are useful when searching for content that could be displayed in a variety of ways. The content may have different attributes that you want to account for in your attempt to locate it within a packet’s payload.
 
     [bookmark: pgfId-2019046]Note that the regular expression syntax used in intrusion rules is a subset of the full regular expression library and varies in some ways from the syntax used in commands in the full library. When adding a pcre keyword using the rule editor, enter the full value in the following format:
 
      
      [bookmark: pgfId-3719777]!/pcre/ ismxAEGRBUIPHDMCKSY 
     
 
     [bookmark: pgfId-1219462]where:
 
      
      	 [bookmark: pgfId-1219463]! is an optional negation (use this if you want to match patterns that  do not match the regular expression).
 
      	 [bookmark: pgfId-1219464] /  pcre  / is a Perl-compatible regular expression.
 
      	 [bookmark: pgfId-3719788] ismxAEGRBUIPHDMCKSY is any combination of modifier options.
 
     
 
      
       
        
        [bookmark: pgfId-2055590]Table 36-16 Escaped PCRE Characters 
 
        
        
         
         	 
           
           [bookmark: pgfId-2055596]You must escape... 
          
  
         	 
           
           [bookmark: pgfId-2055598]with a backslash... 
          
  
         	 
           
           [bookmark: pgfId-2055600]or Hex code... 
          
  
        
 
         
         	[bookmark: pgfId-2055602]# (hash mark)
  
         	[bookmark: pgfId-2055604]\#
  
         	[bookmark: pgfId-2055606]\x23
  
        
 
         
         	[bookmark: pgfId-2055608]; (semicolon)
  
         	[bookmark: pgfId-2055610]\;
  
         	[bookmark: pgfId-2055612]\x3B
  
        
 
         
         	[bookmark: pgfId-2055614]| (vertical bar)
  
         	[bookmark: pgfId-2055616]\|
  
         	[bookmark: pgfId-2055618]\x7C
  
        
 
         
         	[bookmark: pgfId-2055620]: (colon)
  
         	[bookmark: pgfId-2055622]\:
  
         	[bookmark: pgfId-2055624]\x3A
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2218571]Tip Optionally, you can surround your Perl-compatible regular expression with quote characters, for example, pcre_expression or “pcre_expression“.The option of using quotes accommodates experienced users accustomed to previous versions when quotes were required instead of optional. The rule editor does not display quotation marks when you display a rule after saving it.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3719802]You can also use m?regex?, where ? is a delimiter other than /. You may want to use this in situations where you need to match a forward slash within a regular expression and do not want to escape it with a backslash. For example, you might use m?regex? ismxAEGRBUIPHDMCKSY where regex is your Perl-compatible regular expression and ismxAEGRBUIPHDMCKSY is any combination of modifier options. See Perl-Compatible Regular Expression Basics for more information about regular expression syntax.
 
     [bookmark: pgfId-1219471]The following sections provide more information about building valid values for the pcre keyword:
 
      
      	 [bookmark: pgfId-1219475]Perl-Compatible Regular Expression Basics describes the common syntax used in Perl-compatible regular expressions.
 
      	 [bookmark: pgfId-1219479]PCRE Modifier Options describes the options you can use to modify your regular expression.
 
      	 [bookmark: pgfId-1219483]Example PCRE Keyword Values gives example usage of the  pcre keyword in rules.
 
     
 
    
 
     
      [bookmark: pgfId-1219533][bookmark: 75645]Perl-Compatible Regular Exp[bookmark: marker-2606539]ression Basics
 
     [bookmark: pgfId-4238260]License: Protection
 
     [bookmark: pgfId-1219534]The pcre keyword accepts standard Perl-compatible regular expression (PCRE) syntax. The following sections describe that syntax.
 
      
       
     
 
     
 
     [bookmark: pgfId-1219535]Tip While this section describes the basic syntax you may use for PCRE, you may want to consult an online reference or book dedicated to Perl and PCRE for more advanced information. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1219537][bookmark: 34628]Metachar[bookmark: marker-3099233]acters
 
     [bookmark: pgfId-4238273]License: Protection
 
     [bookmark: pgfId-1219538]Metacharacters are literal characters that have special meaning within regular expressions. When you use them within a regular expression, you must “escape” them by preceding them with a backslash. 
 
      
       
        
        [bookmark: pgfId-1447508]Table 36-17 [bookmark: 16746]PCRE Metacharacters 
 
        
        
         
         	 
           
           [bookmark: pgfId-1219541]Metacharacter 
          
  
         	 
           
           [bookmark: pgfId-1219543]Description 
          
  
         	 
           
           [bookmark: pgfId-1219545]Example 
          
  
        
 
         
         	[bookmark: pgfId-1219547].
  
         	[bookmark: pgfId-1219549]Matches any character except newlines. If s is used as a modifying option, it also includes newline characters. 
  
         	[bookmark: pgfId-1219551]abc. matches abcd, abc1, abc#, and so on.
  
        
 
         
         	[bookmark: pgfId-1219553]*
  
         	[bookmark: pgfId-1219555]Matches zero or more occurrences of a character or expression.
  
         	[bookmark: pgfId-1219557]abc* matches abc, abcc, abccc, abccccc, and so on.
  
        
 
         
         	[bookmark: pgfId-1219559]?
  
         	[bookmark: pgfId-1219561]Matches zero or one occurrence of a character or expression.
  
         	[bookmark: pgfId-1219563]abc? matches abc.
  
        
 
         
         	[bookmark: pgfId-1219565]+
  
         	[bookmark: pgfId-1219567]Matches one or more occurrences of a character or expression.
  
         	[bookmark: pgfId-1219569]abc+ matches abc, abcc, abccc, abccccc, and so on.
  
        
 
         
         	[bookmark: pgfId-1219571]()
  
         	[bookmark: pgfId-1219573]Groups expressions.
  
         	[bookmark: pgfId-1219575](abc)+ matches abc, abcabc, abcabcabc and so on.
  
        
 
         
         	[bookmark: pgfId-1219577]{}
  
         	[bookmark: pgfId-1219579]Specifies a limit for the number of matches for a character or expression. If you want to set a lower and upper limit, separate the lower limit and upper limit with a comma. 
  
         	[bookmark: pgfId-1219581]a{4,6} matches aaaa, aaaaa, or aaaaaa.
 [bookmark: pgfId-1219582](ab){2} matches abab.
  
        
 
         
         	[bookmark: pgfId-1219584][]
  
         	[bookmark: pgfId-1219586]Allows you to define character classes, and matches any character or combination of characters described in the set. 
  
         	[bookmark: pgfId-1219588][abc123] matches a or b or c, and so on.
  
        
 
         
         	[bookmark: pgfId-1219590]^
  
         	[bookmark: pgfId-1219592]Matches content at the beginning of a string. Also used for negation, if used within a character class.
  
         	[bookmark: pgfId-1219594]^in matches the “in” in info, but not in bin. [^a] matches anything that does not contain a.
  
        
 
         
         	[bookmark: pgfId-1219596]$
  
         	[bookmark: pgfId-1219598]Matches content at the end of a string.
  
         	[bookmark: pgfId-1219600]ce$ matches the “ce” in announce, but not cent.
  
        
 
         
         	[bookmark: pgfId-1219602]|
  
         	[bookmark: pgfId-1219604]Indicates an OR expression.
  
         	[bookmark: pgfId-1219606](MAILTO|HELP) matches MAILTO or HELP.
  
        
 
         
         	[bookmark: pgfId-1219608]\
  
         	[bookmark: pgfId-1219610]Allows you to use metacharacters as actual characters and is also used to specify a predefined character class.
  
         	[bookmark: pgfId-1219612]\. matches a period, \* matches an asterisk, \\ matches a backslash and so on. \d matches the numeric characters, \w matches alphanumeric characters, and so on. See Character Classes for more information about using character classes in PCRE.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1219615][bookmark: 49976]Character Cla[bookmark: marker-3099245]sses
 
     [bookmark: pgfId-4238286]License: Protection
 
     [bookmark: pgfId-1219616]Character classes include alphabetic characters, numeric characters, alphanumeric characters, and white space characters. While you can create your own character classes within brackets (see Metacharacters), you can use the predefined classes as shortcuts for different types of character types. When used without additional qualifiers, a character class matches a single digit or character.
 
      
       
        
        [bookmark: pgfId-2420219]Table 36-18 [bookmark: 90902]PCRE Character Classes 
 
        
        
         
         	 
           
           [bookmark: pgfId-2420225]Character Class 
          
  
         	 
           
           [bookmark: pgfId-2420227]Description 
          
  
         	 
           
           [bookmark: pgfId-2420229]Character Class Definition 
          
  
        
 
         
         	[bookmark: pgfId-2420231]\d
  
         	[bookmark: pgfId-2420233]Matches a numeric character (“digit”).
  
         	[bookmark: pgfId-2420235][0-9]
  
        
 
         
         	[bookmark: pgfId-2420237]\D
  
         	[bookmark: pgfId-2420239]Matches anything that is not an numeric character.
  
         	[bookmark: pgfId-2420241][^0-9]
  
        
 
         
         	[bookmark: pgfId-2420243]\w
  
         	[bookmark: pgfId-2420245]Matches an alphanumeric character (“word”).
  
         	[bookmark: pgfId-2420247][a-zA-Z0-9_]
  
        
 
         
         	[bookmark: pgfId-2420249]\W
  
         	[bookmark: pgfId-2420251]Matches anything that is not an alphanumeric character.
  
         	[bookmark: pgfId-2420253][^a-zA-Z0-9_]
  
        
 
         
         	[bookmark: pgfId-2420255]\s
  
         	[bookmark: pgfId-2420257]Matches white space characters, including spaces, carriage returns, tabs, newlines, and form feeds.
  
         	[bookmark: pgfId-2420259][ \r\t\n\f]
  
        
 
         
         	[bookmark: pgfId-2420261]\S
  
         	[bookmark: pgfId-2420263]Matches anything that is not a white space character.
  
         	[bookmark: pgfId-2420265][^ \r\t\n\f]
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1219677][bookmark: 84818]PCRE Mod[bookmark: marker-3099246]ifier Opti[bookmark: marker-2606540]ons
 
     [bookmark: pgfId-4238299]License: Protection
 
     [bookmark: pgfId-1219678]You can use modifying options after you specify regular expression syntax in the pcre keyword’s value. These modifiers perform Perl, PCRE, and Snort-specific processing functions. Modifiers always appear at the end of the PCRE value, and appear in the following format:
 
      
      [bookmark: pgfId-3719816]/pcre/ismxAEGRBUIPHDMCKSY 
     
 
     [bookmark: pgfId-1219680]where ismxAEGRBUPHMC can include any of the modifying options that appear in the following tables.
 
      
       
     
 
     
 
     [bookmark: pgfId-3719827]Tip Optionally, you can surround the regular expression and any modifying options with quotes, for example, “/pcre/ismxAEGRBUIPHDMCKSY”. The option of using quotes accommodates experienced users accustomed to previous versions when quotes were required instead of optional. The rule editor does not display quotation marks when you display a rule after saving it.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1924468]Table 36-19 [bookmark: 46656]Perl-Related Post Regular Expression Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1924472]Option 
          
  
         	 
           
           [bookmark: pgfId-1924474]Description 
          
  
        
 
         
         	[bookmark: pgfId-1924476]i
  
         	[bookmark: pgfId-1924478]Makes the regular expression case-insensitive.
  
        
 
         
         	[bookmark: pgfId-1924480]s
  
         	[bookmark: pgfId-1924482]The dot character (.) describes all characters except the newline or \n character. You can use "s" as an option to override this and have the dot character match all characters, including the newline character.
  
        
 
         
         	[bookmark: pgfId-1924484]m
  
         	[bookmark: pgfId-1924486]By default, a string is treated as a single line of characters, and ^ and $ match the beginning and ending of a specific string. When you use "m" as an option, ^ and $ match content immediately before or after any newline character in the buffer, as well as at the beginning or end of the buffer.
  
        
 
         
         	[bookmark: pgfId-1924488]x
  
         	[bookmark: pgfId-1924490]Ignores white space data characters that may appear within the pattern, except when escaped (preceded by a backslash) or included inside a character class.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1924494]The following table describes the PCRE modifiers you can use after the regular expression.
 
     [bookmark: pgfId-1219723]
 
      
       
        
        [bookmark: pgfId-1447594]Table 36-20 [bookmark: 24447]PCRE-Related Post Regular Expression Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1219708]Option 
          
  
         	 
           
           [bookmark: pgfId-1219710]Description 
          
  
        
 
         
         	[bookmark: pgfId-1219712]A
  
         	[bookmark: pgfId-1219714]The pattern must match at the beginning of the string (same as using ^ in a regular expression).
  
        
 
         
         	[bookmark: pgfId-1219716]E
  
         	[bookmark: pgfId-1219718]Sets $ to match only at the end of the subject string. (Without E, $ also matches immediately before the final character if it is a newline, but not before any other newline characters).
  
        
 
         
         	[bookmark: pgfId-1219720]G
  
         	[bookmark: pgfId-1219722]By default, * + and ? are “greedy,” which means that if two or more matches are found, they will choose the longest match. Use the G character to change this so that these characters always choose the first match unless followed by a question mark character (?). For example, *? +? and ?? would be greedy in a construct using the G modifier, and any incidences of *, +, or ? without the additional question mark will not be greedy.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4224289]The following table describes the Snort-specific modifiers that you can use after the regular expression. 
 
     [bookmark: pgfId-3468842].
 
      
       
        
        [bookmark: pgfId-4756982]Table 36-21 [bookmark: 10200]Snort-Specific Post Regular Expression Modifiers 
 
        
        
         
         	 
           
           [bookmark: pgfId-4756986]Option 
          
  
         	 
           
           [bookmark: pgfId-4756988]Description 
          
  
        
 
         
         	[bookmark: pgfId-4756990]R
  
         	[bookmark: pgfId-4756992]Searches for matching content relative to the end of the last match found by the rules engine.
  
        
 
         
         	[bookmark: pgfId-4756994]B
  
         	[bookmark: pgfId-4756996]Searches for the content within data before it is decoded by a preprocessor (this option is similar to using the Raw Data argument with the content or protected_content keyword).
  
        
 
         
         	[bookmark: pgfId-4756998]U
  
         	[bookmark: pgfId-4757000]Searches for the content within the URI of a normalized HTTP request message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the content or protected_content keyword HTTP URI option to search the same content. See HTTP Content Options for more information.
 selected, either with or without an accompanying PCRE expression that uses the U option.
  
        
 
         
         	[bookmark: pgfId-4757006]I
  
         	[bookmark: pgfId-4757008]Searches for the content within the URI of a raw HTTP request message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the content or protected_content keyword HTTP Raw URI option to search the same content. See HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757013]P
  
         	[bookmark: pgfId-4757015]Searches for the content within the body of a normalized HTTP request message decoded by the HTTP Inspect preprocessor. See the content and protected_content keyword HTTP Client Body option in HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757020]H
  
         	[bookmark: pgfId-4757022]Searches for the content within the header, excluding cookies, of an HTTP request or response message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the content or protected_content keyword HTTP Header option to search the same content. See HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757027]D
  
         	[bookmark: pgfId-4757029]Searches for the content within the header, excluding cookies, of a raw HTTP request or response message decoded by the HTTP Inspect preprocessor. Note that you cannot use this option in combination with the content or protected_content keyword HTTP Raw Header option to search the same content. See HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757034]M
  
         	[bookmark: pgfId-4757036]Searches for the content within the method field of a normalized HTTP request message decoded by the HTTP Inspect preprocessor; the method field identifies the action such as GET, PUT, CONNECT, and so on to take on the resource identified in the URI. See the content and protected_content keyword HTTP Method option in HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757041]C
  
         	[bookmark: pgfId-4757043]When the HTTP Inspect preprocessor Inspect HTTP Cookies option is enabled, searches for the normalized content within any cookie in an HTTP request header, and also within any set-cookie in an HTTP response header when the preprocessor Inspect HTTP Responses option is enabled. When Inspect HTTP Cookies is not enabled, searches the entire header, including the cookie or set-cookie data. 
 [bookmark: pgfId-4757044]Note the following:
 
           
           	 [bookmark: pgfId-4757045]Cookies included in the message body are treated as body content.
 
           	 [bookmark: pgfId-4757046]You cannot use this option in combination with the  content or  protected_content keyword  HTTP Cookie option to search the same content. See HTTP Content Options for more information.
 
           	 [bookmark: pgfId-4757050]The  Cookie: and  Set-Cookie: header names, leading spaces on the header line, and the  CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
          
  
        
 
         
         	[bookmark: pgfId-4757052]K
  
         	[bookmark: pgfId-4757054]When the HTTP Inspect preprocessor Inspect HTTP Cookies option is enabled, searches for the raw content within any cookie in an HTTP request header, and also within any set-cookie in an HTTP response header when the preprocessor Inspect HTTP Responses option is enabled. When Inspect HTTP Cookies is not enabled, searches the entire header, including the cookie or set-cookie data. 
 [bookmark: pgfId-4757055]Note the following:
 
           
           	 [bookmark: pgfId-4757056]Cookies included in the message body are treated as body content. 
 
           	 [bookmark: pgfId-4757057]You cannot use this option in combination with the  content or  protected_content keyword  HTTP Raw Cookie option to search the same content. See HTTP Content Options for more information.
 
           	 [bookmark: pgfId-4757061]The  Cookie: and  Set-Cookie: header names, leading spaces on the header line, and the  CRLF that terminates the header line are inspected as part of the header and not as part of the cookie.
 
          
  
        
 
         
         	[bookmark: pgfId-4757063]S
  
         	[bookmark: pgfId-4757065]Searches the 3-digit status code in an HTTP response. See the content and protected_content keyword HTTP Status Code option in HTTP Content Options for more information.
  
        
 
         
         	[bookmark: pgfId-4757070]Y
  
         	[bookmark: pgfId-4757072]Searches the textual description that accompanies the status code in an HTTP response. See the content and protected_content keyword HTTP Status Message option in HTTP Content Options for more information.
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3719843]Note Do not use the U option in combination with the R option. This could cause performance problems. Also, do not use the U option in combination with any other HTTP content option (I, P, H, D, M, C, K, S, or Y).
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1219757][bookmark: 18927]Example PCRE Keyword V[bookmark: marker-2606541]alues
 
     [bookmark: pgfId-4238320]License: Protection
 
     [bookmark: pgfId-2204305]The following examples show values that you could enter for pcre, with descriptions of what each example would match.
 
      
      	 [bookmark: pgfId-2204306] /feedback[(\d{0,1})]?\.cgi/U 
 
     
 
     [bookmark: pgfId-1219760]This example searches packet payload for feedback, followed by zero or one numeric character, followed by .cgi, and located only in URI data.
 
     [bookmark: pgfId-1219761]This example would match:
 
      
       
       	 [bookmark: pgfId-1219762] feedback.cgi  
 
       	 [bookmark: pgfId-1219763] feedback1.cgi 
 
       	 [bookmark: pgfId-1219764] feedback2.cgi  
 
       	 [bookmark: pgfId-1219765] feedback3.cgi 
 
      
 
     
 
     [bookmark: pgfId-1219766]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219767] feedbacka.cgi 
 
       	 [bookmark: pgfId-1219768] feedback11.cgi 
 
       	 [bookmark: pgfId-1219769] feedback21.cgi 
 
       	 [bookmark: pgfId-1219770] feedbackzb.cgi 
 
      
 
      	 [bookmark: pgfId-1219771] /^ez(\w{3,5})\.cgi/iU 
 
     
 
     [bookmark: pgfId-1219772]This example searches packet payload for ez at the beginning of a string, followed by a word of 3 to 5 letters, followed by .cgi. The search is case-insensitive and only searches URI data.
 
     [bookmark: pgfId-1219773]This example would match:
 
      
       
       	 [bookmark: pgfId-1219774] EZBoard.cgi 
 
       	 [bookmark: pgfId-1219775] ezman.cgi 
 
       	 [bookmark: pgfId-1219776] ezadmin.cgi 
 
       	 [bookmark: pgfId-1219777] EZAdmin.cgi 
 
      
 
     
 
     [bookmark: pgfId-1219778]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219779] ezez.cgi 
 
       	 [bookmark: pgfId-1219780] fez.cgi 
 
       	 [bookmark: pgfId-1219781] abcezboard.cgi 
 
       	 [bookmark: pgfId-1219782] ezboardman.cgi 
 
      
 
      	 [bookmark: pgfId-1219783] /mail(file|seek)\.cgi/U 
 
     
 
     [bookmark: pgfId-1219784]This example searches packet payload for mail, followed by either file or seek, in URI data.
 
     [bookmark: pgfId-1219785]This example would match:
 
      
       
       	 [bookmark: pgfId-1219786] mailfile.cgi 
 
       	 [bookmark: pgfId-1219787] mailseek.cgi 
 
      
 
     
 
     [bookmark: pgfId-1219788]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219789] MailFile.cgi 
 
       	 [bookmark: pgfId-2204320] mailfilefile.cgi 
 
      
 
      	 [bookmark: pgfId-2204321] m?http\\x3a\x2f\x2f.*(\n|\t)+?U 
 
     
 
     [bookmark: pgfId-2204322]This example searches packet payload for URI content for a tab or newline character in an HTTP request, after any number of characters. This example uses m?regex? to avoid using http\:\/\/ in the expression. Note that the colon is preceded by a backslash.
 
     [bookmark: pgfId-1219793]This example would match:
 
      
       
       	 [bookmark: pgfId-1219794] http://www.example.com?scriptvar=x&othervar=\n\..\.. 
 
       	 [bookmark: pgfId-1219795] http://www.example.com?scriptvar=\t 
 
      
 
     
 
     [bookmark: pgfId-1219796]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219797] ftp://ftp.example.com?scriptvar=&othervar=\n\..\.. 
 
       	 [bookmark: pgfId-1219798] http://www.example.com?scriptvar=|/bin/sh -i| 
 
      
 
      	 [bookmark: pgfId-1219799] m?http\\x3a\x2f\x2f.*=\|.*\|+?sU 
 
     
 
     [bookmark: pgfId-1219800]This example searches packet payload for a URL with any number of characters, including newlines, followed by an equal sign, and pipe characters that contain any number of characters or white space. This example uses m?regex? to avoid using http\:\/\/ in the expression.
 
     [bookmark: pgfId-1219801]This example would match:
 
      
       
       	 [bookmark: pgfId-1219802] http://www.example.com?value=|/bin/sh/ -i| 
 
       	 [bookmark: pgfId-1219803] http://www.example.com?input=|cat /etc/passwd| 
 
      
 
     
 
     [bookmark: pgfId-1219804]This example would not match:
 
      
       
       	 [bookmark: pgfId-1219805] ftp://ftp.example.com?value=|/bin/sh/ -i| 
 
       	 [bookmark: pgfId-1219806] http://www.example.com?value=x&input?|cat /etc/passwd| 
 
      
 
      	 [bookmark: pgfId-2055632] /[0-9a-f]{2}\:[0-9a-f]{2}\:[0-9a-f]{2}\:[0-9a-f]{2}\:[0-9a-f]{2}\:[0-9a-f]{2}/i 
 
     
 
     [bookmark: pgfId-2055646]This example searches packet payload for any MAC address. Note that it escapes the colon characters with backslashes.
 
    
 
     
      [bookmark: pgfId-2632531][bookmark: 99850]Adding Metad[bookmark: marker-3099247]ata to a Rule
 
     [bookmark: pgfId-4238333]License: Protection
 
     [bookmark: pgfId-2665479]You can use the [bookmark: marker-2665478]metadata keyword to add descriptive information to a rule. You can use the information you add to organize or identify rules in ways that suit your needs, and to search for rules.
 
     [bookmark: pgfId-4040462]The system validates metadata based on the format:
 
      
      [bookmark: pgfId-4040919]key value 
     
 
     [bookmark: pgfId-4040920]where key and value provide a combined description separated by a space. This is the format used by the Cisco VRT for adding metadata to rules provided by Cisco. 
 
     [bookmark: pgfId-4040973]Alternatively, you can also use the format:
 
      
      [bookmark: pgfId-4040922]key=value 
     
 
     [bookmark: pgfId-4042331]For example, you could use the key value format to identify rules by author and date, using a category and sub-category as follows:
 
      
      [bookmark: pgfId-4042322]author SnortGuru_20050406 
     
 
     [bookmark: pgfId-4042323]You can use multiple metadata keywords in a rule. You can also use commas to separate multiple key value statements in a single metadata keyword, as seen in the following example:
 
      
      [bookmark: pgfId-2683802]author SnortGuru_20050406, revised_by SnortUser1_20050707,
revised_by SnortUser2_20061003, revised_by
SnortUser1_20070123 
     
 
     [bookmark: pgfId-4043663]You are not limited to using a key value or key=value format; however, you should be aware of limitations resulting from validation based on these formats.
 
     [bookmark: pgfId-3708614]Avoiding Restricted Characters
 
     [bookmark: pgfId-4775737]License: Protection
 
     [bookmark: pgfId-4775738]Note the following character restrictions:
 
      
      	 [bookmark: pgfId-4775739]Do not use a semicolon (;) or colon (:) in a  metadata keyword.
 
      	 [bookmark: pgfId-4043715]Be aware when using commas that the system interprets a comma as a separator for multiple  key value or  key  =  value statements. For example:
 
     
 
      
      [bookmark: pgfId-4043886]key value, key value, key value 
     
 
      
      	 [bookmark: pgfId-4042732]Be aware when using the equal to (=) character or space character that the system interprets these characters as separators between  key and  value . For example:
 
     
 
      
      [bookmark: pgfId-4044003]key value 
     
 
      
      [bookmark: pgfId-4044018]key=value 
     
 
     [bookmark: pgfId-4568400]All other characters are permitted.
 
     [bookmark: pgfId-4568401]Adding service Metadata
 
     [bookmark: pgfId-4568402]License: Protection
 
     [bookmark: pgfId-4566805]The rules engine applies active rules with service metadata that match the application protocol information for the host in a packet to analyze and process traffic. If it does not match, the system does not apply the rule to the traffic. If a host does not have application protocol information, or if the rule does not have service metadata, the system checks the port in the traffic against the port in the rule to determine whether to apply the rule to the traffic.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4566815]To match a rule with an identified application protocol, you must define the metadata keyword and a key value statement, with service as the key and an application for the value. For example, the following key value statement in a metadata keyword associates the rule with HTTP traffic:
 
      
      [bookmark: pgfId-4566816]service http 
     
 
     [bookmark: pgfId-4566820]The following table describes the most common application values.
 
      
       
     
 
     
 
     [bookmark: pgfId-4566824]Note Contact Support for assistance in defining applications not in the table. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4568501]
 
      
       
        
        [bookmark: pgfId-4568414]Table 36-22 [bookmark: 20501]service Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-4568418]Value 
          
  
         	 
           
           [bookmark: pgfId-4568420]Description 
          
  
        
 
         
         	[bookmark: pgfId-4568422]dcerpc
  
         	[bookmark: pgfId-4568424]Distributed Computing Environment/Remote Procedure Calls System
  
        
 
         
         	[bookmark: pgfId-4568426]dns
  
         	[bookmark: pgfId-4568428]Domain Name System
  
        
 
         
         	[bookmark: pgfId-4568430]finger
  
         	[bookmark: pgfId-4568432]Finger user information protocol
  
        
 
         
         	[bookmark: pgfId-4568434]ftp
  
         	[bookmark: pgfId-4568436]File Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568438]ftp-data
  
         	[bookmark: pgfId-4568440]File Transfer Protocol (Data Channel)
  
        
 
         
         	[bookmark: pgfId-4568442]http
  
         	[bookmark: pgfId-4568444]Hypertext Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568446]imap
  
         	[bookmark: pgfId-4568448]Internet Message Access Protocol
  
        
 
         
         	[bookmark: pgfId-4568450]isakmp
  
         	[bookmark: pgfId-4568452]Internet Security Association and Key Management Protocol
  
        
 
         
         	[bookmark: pgfId-4568454]netbios-dgm
  
         	[bookmark: pgfId-4568456]NETBIOS Datagram Service
  
        
 
         
         	[bookmark: pgfId-4568458]netbios-ns
  
         	[bookmark: pgfId-4568460]NETBIOS Name Service
  
        
 
         
         	[bookmark: pgfId-4568462]netbios-ssn
  
         	[bookmark: pgfId-4568464]NETBIOS Session Service
  
        
 
         
         	[bookmark: pgfId-4568466]nntp
  
         	[bookmark: pgfId-4568468]Network News Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568470]oracle
  
         	[bookmark: pgfId-4568472]Oracle Net Services
  
        
 
         
         	[bookmark: pgfId-4568474]pop2
  
         	[bookmark: pgfId-4568476]Post Office Protocol, version 2
  
        
 
         
         	[bookmark: pgfId-4568478]pop3
  
         	[bookmark: pgfId-4568480]Post Office Protocol, version 3
  
        
 
         
         	[bookmark: pgfId-4568482]smtp
  
         	[bookmark: pgfId-4568484]Simple Mail Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568486]ssh
  
         	[bookmark: pgfId-4568488]Secure Shell network protocol
  
        
 
         
         	[bookmark: pgfId-4568490]telnet
  
         	[bookmark: pgfId-4568492]Telnet network protocol
  
        
 
         
         	[bookmark: pgfId-4568494]tftp
  
         	[bookmark: pgfId-4568496]Trivial File Transfer Protocol
  
        
 
         
         	[bookmark: pgfId-4568498]x11
  
         	[bookmark: pgfId-4568500]X Window System
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4568503][bookmark: 18421]Avoiding Reserved Metadata
 
     [bookmark: pgfId-4568507]License: Protection
 
     [bookmark: pgfId-4044201]Avoid using the following words in a metadata keyword, either as a single argument or as the key in a key value statement; these are reserved for use by the VRT:
 
      
      [bookmark: pgfId-2665495]application 
     
 
      
      [bookmark: pgfId-2665496]engine 
     
 
      
      [bookmark: pgfId-4042465]impact_flag 
     
 
      
      [bookmark: pgfId-2665497]os 
     
 
      
      [bookmark: pgfId-4042450]policy 
     
 
      
      [bookmark: pgfId-2665498]rule-type 
     
 
      
      [bookmark: pgfId-4551021]rule-flushing 
     
 
      
      [bookmark: pgfId-4551023]soid 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4570741]Note Contact Support for assistance in adding restricted metadata to local rules that might not otherwise function as expected. See Importing Local Rule Files for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4550963][bookmark: 66703]Searching for Rules with Metadata
 
     [bookmark: pgfId-4550967]License: Protection
 
     [bookmark: pgfId-2670718]To search for rules that use the metadata keyword, select the metadata keyword on the rules Search page and, optionally, type any portion of the metadata. For example, you can type:
 
      
      	 [bookmark: pgfId-2665506] author to display all rules where you have used  author for  key .
 
      	 [bookmark: pgfId-2665507] author snortguru to display all rules where you have used  author for  key and  SnortGuru for  value .
 
      	 [bookmark: pgfId-2665508] author s to display all rules where you have used  author for  key and any terms such as  SnortGuru or  SnortUser1 or  SnortUser2 for  value .
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4567684]Tip When you search for both key and value, use the same connecting operator (equal to [=] or a space character) in searches that is used in the key value statement in the rule; searches return different results depending on whether you follow key with equal to (=) or a space character.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4567685]Note that regardless of the format you use to add metadata, the system interprets your metadata search term as all or part of a key value or key=value statement. For example, the following would be valid metadata that does not follow a key value or key=value format:
 
      
      [bookmark: pgfId-4043186]ab cd ef gh 
     
 
     [bookmark: pgfId-4043205]However, the system would interpret each space in the example as a separator between a key and value. Thus, you could successfully locate a rule containing the example metadata using any of the following searches for juxtaposed and single terms:
 
      
      [bookmark: pgfId-4043274]cd ef 
     
 
      
      [bookmark: pgfId-4043281]ef gh 
     
 
      
      [bookmark: pgfId-4043640]ef 
     
 
     [bookmark: pgfId-4043228]but you would not locate the rule using the following search, which the system would interpret as a single key value statement:
 
      
      [bookmark: pgfId-4043292]ab ef 
     
 
     [bookmark: pgfId-4043154]For more information, see Searching for Rules.
 
     [bookmark: pgfId-4042912][bookmark: 23163]Setting Impact Level 1
 
     [bookmark: pgfId-4238393]License: Protection
 
     [bookmark: pgfId-4042926]You can use the following reserved key value statement in a metadata keyword:
 
      
      [bookmark: pgfId-4042927]impact_flag red 
     
 
     [bookmark: pgfId-4042928]This key value statement sets the impact flag to red (level 1) for a local rule you import or a custom rule you create using the rule editor.
 
     [bookmark: pgfId-4042932]Note that when the VRT includes the impact_flag red statement in a rule provided by Cisco, the VRT has determined that a packet triggering the rule indicates that the source or destination host is potentially compromised by a virus, trojan, or other piece of malicious software. See Using Impact Levels to Evaluate Events a for more information.
 
    
 
     
      [bookmark: pgfId-1219153][bookmark: 59115]Inspecting IP[bookmark: marker-2334566] Header Values
 
     [bookmark: pgfId-4238406]License: Protection
 
     [bookmark: pgfId-1058909]You can use keywords to identify possible attacks or security policy violations in the IP headers of packets. See the following sections for more information:
 
      
      	 [bookmark: pgfId-1058910]Inspecting Fragments and Reserved Bits
 
      	 [bookmark: pgfId-1058911]Inspecting the IP Header Identification Value
 
      	 [bookmark: pgfId-1058912]Identifying Specified IP Options
 
      	 [bookmark: pgfId-1058913]Identifying Specified IP Protocol Numbers
 
      	 [bookmark: pgfId-1058914]Inspecting a Packet’s Type of Service
 
      	 [bookmark: pgfId-1058915]Inspecting a Packet’s Time-To-Live Value
 
     
 
    
 
     
      [bookmark: pgfId-1059512][bookmark: 57081]Inspecting Fragments and Reserved Bits
 
     [bookmark: pgfId-4238419]License: Protection
 
      
       
        
        [bookmark: pgfId-1467180]Table 36-23 Fragbits Argument Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-1059517]Argument 
          
  
         	 
           
           [bookmark: pgfId-1059519]Description 
          
  
        
 
         
         	[bookmark: pgfId-1059521]R
  
         	[bookmark: pgfId-1059523]Reserved bit
  
        
 
         
         	[bookmark: pgfId-1059525]M
  
         	[bookmark: pgfId-1059527]More Fragments bit
  
        
 
         
         	[bookmark: pgfId-1059529]D
  
         	[bookmark: pgfId-1059531]Don’t Fragment bit
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1059533]To further refine a rule using the fragbits keyword, you can specify any operator described in the following table after the argument value in the rule. 
 
     [bookmark: pgfId-1467208]
 
      
       
        
        [bookmark: pgfId-1467232]Table 36-24 [bookmark: 98324]Fragbit Operators 
 
        
        
         
         	 
           
           [bookmark: pgfId-1467236]Operator 
          
  
         	 
           
           [bookmark: pgfId-1467238]Description 
          
  
        
 
         
         	[bookmark: pgfId-1467240]plus sign (+)
  
         	[bookmark: pgfId-1467242]The packet must match against all specified bits.
  
        
 
         
         	[bookmark: pgfId-1467244]asterisk (*) 
  
         	[bookmark: pgfId-1467246]The packet can match against any of the specified bits.
  
        
 
         
         	[bookmark: pgfId-1467248]exclamation point (!)
  
         	[bookmark: pgfId-1467347]The packet meets the criteria if none of the specified bits are set.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1467358]For example, to generate an event against packets that have the Reserved Bit set (and possibly any other bits), use R+ as the fragbits value. 
 
    
 
     
      [bookmark: pgfId-1157636][bookmark: 76169]Inspecting the IP Header Identification Value
 
     [bookmark: pgfId-4238432]License: Protection
 
     [bookmark: pgfId-1059565]The [bookmark: marker-1059564]id keyword tests the IP header fragment identification field against the value you specify in the keyword’s argument. Some denial-of-service tools and scanners set this field to a specific number that is easy to detect. For example, in SID 630, which detects a Synscan portscan, the id value is set to 39426, the static value used as the ID number in packets transmitted by the scanner. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1558525]Note id argument values must be numeric.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059594][bookmark: 11702]Identifying Specified IP Options
 
     [bookmark: pgfId-4238445]License: Protection
 
     [bookmark: pgfId-1059596]The [bookmark: marker-1059595]IPopts keyword allows you to search packets for specified IP header options. The following table lists the available argument values.
 
     [bookmark: pgfId-1059634]
 
      
       
        
        [bookmark: pgfId-1447522]Table 36-25 [bookmark: 50271]IPoption Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1059599]Argument 
          
  
         	 
           
           [bookmark: pgfId-1059601]Description 
          
  
        
 
         
         	[bookmark: pgfId-1059603]rr
  
         	[bookmark: pgfId-1059605]record route
  
        
 
         
         	[bookmark: pgfId-1059607]eol
  
         	[bookmark: pgfId-1059609]end of list
  
        
 
         
         	[bookmark: pgfId-1059611]nop
  
         	[bookmark: pgfId-1059613]no operation
  
        
 
         
         	[bookmark: pgfId-1059615]ts
  
         	[bookmark: pgfId-1059617]time stamp
  
        
 
         
         	[bookmark: pgfId-1059619]sec
  
         	[bookmark: pgfId-1059621]IP security option
  
        
 
         
         	[bookmark: pgfId-1059623]lsrr
  
         	[bookmark: pgfId-1059625]loose source routing
  
        
 
         
         	[bookmark: pgfId-1059627]ssrr
  
         	[bookmark: pgfId-1059629]strict source routing
  
        
 
         
         	[bookmark: pgfId-1059631]satid
  
         	[bookmark: pgfId-1059633]stream identifier
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1059635]Analysts most frequently watch for strict and loose source routing because these options may be an indication of a spoofed source IP address.
 
    
 
     
      [bookmark: pgfId-2804378][bookmark: 65505]Identifying Specified IP Protocol Numbers
 
     [bookmark: pgfId-4238458]License: Protection
 
     [bookmark: pgfId-2804380]The [bookmark: marker-2804379]ip_proto keyword allows you to identify packets with the IP protocol specified as the keyword’s value. You can specify the IP protocols as a number, 0 through 255. You can find the complete list of protocol numbers at http://www.iana.org/assignments/protocol-numbers. You can combine these numbers with the following operators: <, >, or !. For example, to inspect traffic with any protocol that is not ICMP, use !1 as a value to the ip_proto keyword. You can also use the ip_proto keyword multiple times in a single rule; note, however, that the rules engine interprets multiple instances of the keyword as having a Boolean AND relationship. For example, if you create a rule containing ip_proto:!3; ip_proto:!6, the rule ignores traffic using the GGP protocol AND the TCP protocol. 
 
    
 
     
      [bookmark: pgfId-1059691][bookmark: 17841]Inspecting a Packet’s Type of Service
 
     [bookmark: pgfId-4238471]License: Protection
 
     [bookmark: pgfId-1059692][bookmark: marker-1161983]Some networks use the type of service (ToS) value to set precedence for packets traveling on that network. The tos keyword allows you to test the packet’s IP header ToS value against the value you specify as the keyword’s argument. Rules using the tos keyword will trigger on packets whose ToS is set to the specified value and that meet the rest of the criteria set forth in the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-2011782]Note Argument values for tos must be numeric.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1152489]The ToS field has been deprecated in the IP header protocol and replaced with the Differentiated Services Code Point (DSCP) field.
 
    
 
     
      [bookmark: pgfId-1078061][bookmark: 98543]Inspecting a Packet’s Time-To-Live Value
 
     [bookmark: pgfId-4238484]License: Protection
 
     [bookmark: pgfId-1078104][bookmark: marker-1161984]A packet’s time-to-live (ttl) value indicates how many hops it can make before it is dropped. You can use the ttl keyword to test the packet’s IP header ttl value against the value, or range of values, you specify as the keyword’s argument. It may be helpful to set the ttl keyword parameter to a low value such as 0 or 1, as low time-to-live values are sometimes indicative of a traceroute or intrusion evasion attempt. (Note, though, that the appropriate value for this keyword depends on your managed device placement and network topology.) Use syntax as follows:
 
      
      	 [bookmark: pgfId-4110321]Use an integer from 0 to 255 to set a specific value for the TTL value. You can also precede the value with an equal (=) sign (for example, you can specify  5 or  =5 ).
 
      	 [bookmark: pgfId-4110322]Use a hyphen ( - ) to specify a range of TTL values (for example,  0-2  specifies all values 0 through 2,  -5 specifies all values 0 through 5, and  5- specifies all values 5 through 255). 
 
      	 [bookmark: pgfId-4110277]Use the greater than (>) sign to specify TTL values greater than a specific value (for example,  >3 specifies all values greater than 3).
 
      	 [bookmark: pgfId-4110278]Use the greater than and equal to signs (>=) to specify TTL values greater than or equal to a specific value (for example,  >=3 specifies all values greater than or equal to 3). 
 
      	 [bookmark: pgfId-4110281]Use the less than (<) sign to specify TTL values less than a specific value (for example,  <3 specifies all values less than 3). 
 
      	 [bookmark: pgfId-4110282]Use the less than and equal to signs (<=) to specify TTL values less than or equal to a specific value (for example,  <=3 specifies all values less than or equal to 3). 
 
     
 
    
 
     
      [bookmark: pgfId-1078657][bookmark: 12310]Inspecting ICMP[bookmark: marker-2334567] Header Values
 
     [bookmark: pgfId-4238497]License: Protection
 
     [bookmark: pgfId-1161963]The FireSIGHT System supports keywords that you can use to identify attacks and security policy violations in the headers of ICMP packets. Note, however, that predefined rules exist that detect most ICMP types and codes. Consider enabling an existing rule or creating a local rule based on an existing rule; you may be able to find a rule that meets your needs more quickly than if you build an ICMP rule from scratch.
 
     [bookmark: pgfId-2019571]See the following sections for more information about ICMP-specific keywords:
 
      
      	 [bookmark: pgfId-1161967]Identifying Static ICMP ID and Sequence Values
 
      	 [bookmark: pgfId-1161971]Inspecting the ICMP Message Type
 
      	 [bookmark: pgfId-1078662]Inspecting the ICMP Message Code
 
     
 
    
 
     
      [bookmark: pgfId-1078663][bookmark: 75032]Identifying Static ICMP ID and Sequence Values
 
     [bookmark: pgfId-4238510]License: Protection
 
     [bookmark: pgfId-1078665]The ICMP identification and sequence numbers help associate ICMP replies with ICMP requests. In normal traffic, these values are dynamically assigned to packets. Some covert channel and Distributed Denial of Server (DDoS) programs use static ICMP ID and sequence values. The following keywords allow you to identify ICMP packets with static values.
 
     [bookmark: pgfId-1078834][bookmark: marker-1161985]icmp_id 
 
     [bookmark: pgfId-1115888]The icmp_id keyword inspects an ICMP echo request or reply packet's ICMP ID number. Use a numeric value that corresponds with the ICMP ID number as the argument for the icmp_id keyword.
 
     [bookmark: pgfId-1078668][bookmark: marker-1078667]icmp_seq 
 
     [bookmark: pgfId-1115889]The icmp_seq keyword inspects an ICMP echo request or reply packet's ICMP sequence. Use a numeric value that corresponds with the ICMP sequence number as the argument for the icmp_seq keyword.
 
    
 
     
      [bookmark: pgfId-1078669][bookmark: 28338]Inspecting the ICMP Message Type
 
     [bookmark: pgfId-4238523]License: Protection
 
     [bookmark: pgfId-1467445]Use the [bookmark: marker-1467444]itype keyword to look for packets with specific ICMP message type values. You can specify either a valid ICMP type value (see http://www.iana.org/assignments/icmp-parameters or http://www.faqs.org/rfcs/rfc792.html for a full list of ICMP type numbers) or an invalid ICMP type value to test for different types of traffic. For example, attackers may set ICMP type values out of range to cause denial of service and flooding attacks.
 
     [bookmark: pgfId-1586372]You can specify a range for the itype argument value using less than (<) and greater than (>).
 
     [bookmark: pgfId-1586373]For example:
 
      
      	 [bookmark: pgfId-1586374]<35
 
      	 [bookmark: pgfId-1586375]>36
 
      	 [bookmark: pgfId-1586376]3<>55
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1471132]Tip See http://www.iana.org/assignments/icmp-parameters or http://www.faqs.org/rfcs/rfc792.html for a full list of ICMP type numbers.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1078672][bookmark: 29110]Inspecting the ICMP Message Code
 
     [bookmark: pgfId-4238536]License: Protection
 
     [bookmark: pgfId-1078674]ICMP messages sometimes include a code value that provides details when a destination is unreachable. (See the second section in http://www.iana.org/assignments/icmp-parameters for a full list of ICMP message codes correlated with the message types for which they can be used.)
 
     [bookmark: pgfId-1079273]You can use the icode[bookmark: marker-1078673] keyword to identify packets with specific ICMP code values. You can choose to specify either a valid ICMP code value or an invalid ICMP code value to test for different types of traffic. 
 
     [bookmark: pgfId-1585964]You can specify a range for the icode argument value using less than (<) and greater than (>).
 
     [bookmark: pgfId-1585966]For example:
 
      
      	 [bookmark: pgfId-1585969]to find values less than 35, specify  <35. 
 
      	 [bookmark: pgfId-2011838]to find values greater than 36, specify  >36. 
 
      	 [bookmark: pgfId-1585953]to find values between 3 and 55, specify  3<>55. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1079524]Tip You can use the icode and itype keywords together to identify traffic that matches both. For example, to identify ICMP traffic that contains an ICMP Destination Unreachable code type with an ICMP Port Unreachable code type, specify an itype keyword with a value of 3 (for Destination Unreachable) and an icode keyword with a value of 3 (for Port Unreachable).
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1078428][bookmark: 48480]Inspecting TCP[bookmark: marker-2334568] Header Values and Stream Size
 
     [bookmark: pgfId-4238549]License: Protection
 
     [bookmark: pgfId-1078429]The FireSIGHT System supports keywords that are designed to identify attacks attempted using TCP headers of packets and TCP stream size. See the following sections for more information about TCP-specific keywords:
 
      
      	 [bookmark: pgfId-1078433]Inspecting the TCP Acknowledgment Value
 
      	 [bookmark: pgfId-1153514]Inspecting TCP Flag Combinations
 
      	 [bookmark: pgfId-1153515]Applying Rules to a TCP or UDP Client or Server Flow
 
      	 [bookmark: pgfId-1153522]Identifying Static TCP Sequence Numbers
 
      	 [bookmark: pgfId-2641076]Identifying TCP Windows of a Given Size
 
      	 [bookmark: pgfId-1153523]Identifying TCP Streams of a Given Size
 
     
 
    
 
     
      [bookmark: pgfId-1078451][bookmark: 12773]Inspecting the TCP Acknowledgment Value
 
     [bookmark: pgfId-4238562]License: Protection
 
     [bookmark: pgfId-1356154]You can use the [bookmark: marker-1078453]ack keyword to compare a value against a packet’s TCP acknowledgment number. The rule triggers if a packet’s TCP acknowledgment number matches the value specified for the ack keyword. 
 
     [bookmark: pgfId-2012016]Argument values for ack must be numeric.
 
    
 
     
      [bookmark: pgfId-1078455][bookmark: 94359]Inspecting TCP Flag Combinations
 
     [bookmark: pgfId-4238575]License: Protection
 
     [bookmark: pgfId-1078456]You can use the [bookmark: marker-1161986]flags keyword to specify any combination of TCP flags that, when set in an inspected packet, cause the rule to trigger. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1153600]Note In situations where you would traditionally use A+ as the value for flags, you should instead use the flow keyword with a value of established. Generally, you should use the flow keyword with a value of stateless when using flags to ensure that all combinations of flags are detected. See Applying Rules to a TCP or UDP Client or Server Flow for more information about the flow keyword.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1668739]Table 36-26 [bookmark: 64907]flag Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1668743]Argument 
          
  
         	 
           
           [bookmark: pgfId-1668745]TCP Flag 
          
  
        
 
         
         	[bookmark: pgfId-1668804]Ack
  
         	[bookmark: pgfId-1668806]Acknowledges data.
  
        
 
         
         	[bookmark: pgfId-1668992]Psh
  
         	[bookmark: pgfId-1668994]Data should be sent in this packet.
  
        
 
         
         	[bookmark: pgfId-1668747]Syn
  
         	[bookmark: pgfId-1668749]A new connection.
  
        
 
         
         	[bookmark: pgfId-1669180]Urg
  
         	[bookmark: pgfId-1669182]Packet contains urgent data.
  
        
 
         
         	[bookmark: pgfId-1668751]Fin
  
         	[bookmark: pgfId-1668753]A closed connection.
  
        
 
         
         	[bookmark: pgfId-1668755]Rst
  
         	[bookmark: pgfId-1668757]An aborted connection.
  
        
 
         
         	[bookmark: pgfId-1669199]CWR
  
         	[bookmark: pgfId-1669201]An ECN congestion window has been reduced. This was formerly the R1 argument, which is still supported for backward compatibility.
  
        
 
         
         	[bookmark: pgfId-1668771]ECE
  
         	[bookmark: pgfId-1668773]ECN echo. This was formerly the R2 argument, which is still supported for backward compatibility.
  
        
 
        
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1078503]Tip For more information on Explicit Congestion Notification (ECN), see the information provided at: http://www.faqs.org/rfcs/rfc3168.html.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-1467802]Table 36-27 [bookmark: 58804]Operators Used with flags 
 
        
        
         
         	 
           
           [bookmark: pgfId-1467806]Operator 
          
  
         	 
           
           [bookmark: pgfId-1467808]Description 
          
  
         	 
           
           [bookmark: pgfId-1468002]Example 
          
  
        
 
         
         	[bookmark: pgfId-1467810]all
  
         	[bookmark: pgfId-1467812]The packet must contain all specified flags.
  
         	[bookmark: pgfId-1468004]Select Urg and all to specify that a packet must contain the Urgent flag and may contain any other flags. 
  
        
 
         
         	[bookmark: pgfId-1467814]any
  
         	[bookmark: pgfId-1467816]The packet can contain any of the specified flags.
  
         	[bookmark: pgfId-1468226]Select Ack, Psh, and any to specify that either or both the Ack and Psh flags must be set to trigger the rule, and that other flags may also be set on a packet.
  
        
 
         
         	[bookmark: pgfId-1467818]not 
  
         	[bookmark: pgfId-1467820]The packet must not contain the specified flag set.
  
         	[bookmark: pgfId-1468008]Select Urg and not to specify that the Urgent flag is not set on packets that trigger this rule.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1078509][bookmark: 90818]Applying Rules to a TCP or UDP Client or Server Flow
 
     [bookmark: pgfId-4238592]License: Protection
 
     [bookmark: pgfId-1989716]You can use the [bookmark: marker-1989715]flow keyword to select packets for inspection by a rule based on session characteristics. The flow keyword allows you to specify the direction of the traffic flow to which a rule applies, applying rules to either the client flow or server flow. To specify how the flow keyword inspects your packets, you can set the direction of traffic you want analyzed, the state of packets inspected, and whether the packets are part of a rebuilt stream.
 
     [bookmark: pgfId-3293902]Stateful inspection of packets occurs when rules are processed. If you want a TCP rule to ignore stateless traffic (traffic without an established session context), you must add the flow keyword to the rule and select the Established argument for the keyword. If you want a UDP rule to ignore stateless traffic, you must add the flow keyword to the rule and select either the Established argument or a directional argument, or both. This causes the TCP or UDP rule to perform stateful inspection of a packet.
 
     [bookmark: pgfId-3293903]When you add a directional argument, the rules engine inspects only those packets that have an established state with a flow that matches the direction specified. For example, if you add the flow keyword with the established argument and the From Client argument to a rule that triggers when a TCP or UDP connection is detected, the rules engine only inspects packets that are sent from the client.
 
      
       
     
 
     
 
     [bookmark: pgfId-3293904]Tip For maximum performance, always include a flow keyword in a TCP rule or a UDP session rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3293905]To specify flow, select the flow keyword from the Detection Options list on the Create Rule page and click Add Option. Next, select the arguments from the list provided for each field.
 
     [bookmark: pgfId-1561899]The following table describes the stream-related arguments you can specify for the flow keyword:
 
     [bookmark: pgfId-1561921]
 
      
       
        
        [bookmark: pgfId-1561906]Table 36-28 [bookmark: 86925]State-Related flow Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1561910]Argument 
          
  
         	 
           
           [bookmark: pgfId-1561912]Description 
          
  
        
 
         
         	[bookmark: pgfId-1561914]Established
  
         	[bookmark: pgfId-1561916]Triggers on established connections.
  
        
 
         
         	[bookmark: pgfId-1561918]Stateless
  
         	[bookmark: pgfId-1561920]Triggers regardless of the state of the stream processor.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1489095]The following table describes the directional options you can specify for the flow keyword:
 
     [bookmark: pgfId-1078533]
 
      
       
        
        [bookmark: pgfId-1447518]Table 36-29 [bookmark: 53900]flow Directional Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1078514]Argument 
          
  
         	 
           
           [bookmark: pgfId-1078516]Description 
          
  
        
 
         
         	[bookmark: pgfId-1078518]To Client
  
         	[bookmark: pgfId-1078520]Triggers on server responses.
  
        
 
         
         	[bookmark: pgfId-1078522]To Server
  
         	[bookmark: pgfId-1078524]Triggers on client responses.
  
        
 
         
         	[bookmark: pgfId-1078526]From Client
  
         	[bookmark: pgfId-1078528]Triggers on client responses.
  
        
 
         
         	[bookmark: pgfId-1078530]From Server
  
         	[bookmark: pgfId-1078532]Triggers on server responses.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1078535]Notice that From Server and To Client perform the same function, as do To Server and From Client. These options exist to add context and readability to the rule. For example, if you create a rule designed to detect an attack from a server to a client, use From Server. But, if you create a rule designed to detect an attack from the client to the server, use From Client.
 
      
       
        
        [bookmark: pgfId-2391718]Table 36-30 [bookmark: 52569]Stream-Related flow Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-2391722]Argument 
          
  
         	 
           
           [bookmark: pgfId-2391724]Description 
          
  
        
 
         
         	[bookmark: pgfId-2391726]Ignore Stream Traffic
  
         	[bookmark: pgfId-2391728]Does not trigger on rebuilt stream packets.
  
        
 
         
         	[bookmark: pgfId-2391730]Only Stream Traffic
  
         	[bookmark: pgfId-2391732]Triggers only on rebuilt stream packets.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2406861]For example, you can use To Server, Established, Only Stream Traffic as the value for the flow keyword to detect traffic, traveling from a client to the server in an established session, that has been reassembled by the stream preprocessor.
 
    
 
     
      [bookmark: pgfId-1078587][bookmark: 83009]Identifying Static TCP Sequence Numbers
 
     [bookmark: pgfId-4238605]License: Protection
 
     [bookmark: pgfId-1078588]The [bookmark: marker-1161988]seq keyword allows you to specify a static sequence number value. Packets whose sequence number matches the specified argument trigger the rule containing the keyword. While this keyword is used rarely, it is helpful in identifying attacks and network scans that use generated packets with static sequence numbers.
 
    
 
     
      [bookmark: pgfId-1118471][bookmark: 60569]Identifying TCP Windows of a Given Size
 
     [bookmark: pgfId-4238622]License: Protection
 
     [bookmark: pgfId-2804610]You can use the [bookmark: marker-2804609]window keyword to specify the TCP window size you are interested in. A rule containing this keyword triggers whenever it encounters a packet with the specified TCP window size. While this keyword is used rarely, it is helpful in identifying attacks and network scans that use generated packets with static TCP window sizes.
 
    
 
     
      [bookmark: pgfId-2672490][bookmark: 81132]Identifying TCP Streams of a Given Size
 
     [bookmark: pgfId-4238639]License: Protection
 
     [bookmark: pgfId-2672492]You can use the [bookmark: marker-2672491]stream_size keyword in conjunction with the stream preprocessor to determine the size in bytes of a TCP stream, using the format:
 
      
      [bookmark: pgfId-2674667]direction,operator,bytes 
     
 
     [bookmark: pgfId-2674708]where bytes is number of bytes. You must separate each option in the argument with a comma (,).
 
      
       
        
        [bookmark: pgfId-2674673]Table 36-31 [bookmark: 84093]stream_size Keyword Directional Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-2674677]Argument 
          
  
         	 
           
           [bookmark: pgfId-2674679]Description 
          
  
        
 
         
         	[bookmark: pgfId-2674681]client
  
         	[bookmark: pgfId-2674683]triggers on a stream from the client matching the specified stream size.
  
        
 
         
         	[bookmark: pgfId-2674685]server
  
         	[bookmark: pgfId-2674687]triggers on a stream from the server matching the specified stream size.
  
        
 
         
         	[bookmark: pgfId-2674689]both
  
         	[bookmark: pgfId-2674691]triggers on traffic from the client and traffic from the server both matching the specified stream size.
 [bookmark: pgfId-2679579]For example, the argument both, >, 200 would trigger when traffic from the client is greater than 200 bytes AND traffic from the server is greater than 200 bytes.
  
        
 
         
         	[bookmark: pgfId-2674693]either
  
         	[bookmark: pgfId-2674695]triggers on traffic from either the client or the server matching the specified stream size, whichever occurs first.
 [bookmark: pgfId-2679853]For example, the argument either, >, 200 would trigger when traffic from the client is greater than 200 bytes OR traffic from the server is greater than 200 bytes.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2674763]The following table describes the operators you can use with the stream_size keyword:
 
     [bookmark: pgfId-2674560]
 
      
       
        
        [bookmark: pgfId-2674533]Table 36-32 [bookmark: 69774]stream_size Keyword Argument Operators 
 
        
        
         
         	 
           
           [bookmark: pgfId-2674537]Operator 
          
  
         	 
           
           [bookmark: pgfId-2674539]Description 
          
  
        
 
         
         	[bookmark: pgfId-2674541]=
  
         	[bookmark: pgfId-2674543]equal to
  
        
 
         
         	[bookmark: pgfId-2674623]!=
  
         	[bookmark: pgfId-2674625]not equal to
  
        
 
         
         	[bookmark: pgfId-2674545]>
  
         	[bookmark: pgfId-2674547]greater than
  
        
 
         
         	[bookmark: pgfId-2674549]<
  
         	[bookmark: pgfId-2674551]less than
  
        
 
         
         	[bookmark: pgfId-2674553]>=
  
         	[bookmark: pgfId-2674555] greater than or equal to
  
        
 
         
         	[bookmark: pgfId-2674557]<=
  
         	[bookmark: pgfId-2674559]less than or equal to
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4118095]For example, you could use client, >=, 5001216 as the argument for the stream_size keyword to detect a TCP stream traveling from a client to a server and greater than or equal to 5001216 bytes.
 
    
 
     
      [bookmark: pgfId-4118098][bookmark: 94582]Enabling and Disa[bookmark: marker-4118097]bling TCP Stream Reassembly
 
     [bookmark: pgfId-4238656]License: Protection
 
     [bookmark: pgfId-4118113]You can use the stream_reassemble keyword to enable or disable TCP stream reassembly for a single connection when inspected traffic on the connection matches the conditions of the rule. Optionally, you can use this keyword multiple times in a rule.
 
     [bookmark: pgfId-4118114]Use the following syntax to enable or disable stream reassembly:
 
      
      [bookmark: pgfId-4118115]enable|disable, server|client|both, option, option 
     
 
     [bookmark: pgfId-4118119]The following table describes the optional arguments you can use with the stream_reassemble keyword. 
 
     [bookmark: pgfId-4118138]
 
      
       
        
        [bookmark: pgfId-4118123]Table 36-33 [bookmark: 85814]stream_reassemble Optional Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4118127]Argument 
          
  
         	 
           
           [bookmark: pgfId-4118129]Description 
          
  
        
 
         
         	[bookmark: pgfId-4118131]noalert
  
         	[bookmark: pgfId-4118133]Generate no events regardless of any other detection options specified in the rule.
  
        
 
         
         	[bookmark: pgfId-4118135]fastpath
  
         	[bookmark: pgfId-4118137]Ignore the rest of the connection traffic when there is a match.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4118139]For example, the following rule disables TCP client-side stream reassembly without generating an event on the connection where a 200 OK status code is detected in an HTTP response:
 
      
      [bookmark: pgfId-4118140]alert tcp any 80 -> any any (flow:to_client, established; content: “200 OK”; stream_reassemble:disable, client, noalert 
     
 
     [bookmark: pgfId-4118145]To use stream_reassemble:
 
     [bookmark: pgfId-4438440]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4118146]Step 1 On the Create Rule page, select stream_reassemble in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4118147]The stream_reassemble section appears.
 
     [bookmark: pgfId-4776215]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4118154][bookmark: 18634]Extracting SSL Info[bookmark: marker-4118153]rmation from a Session
 
     [bookmark: pgfId-4238670]License: Protection
 
     [bookmark: pgfId-2867382]You can use SSL rule keywords to invoke the Secure Sockets Layer (SSL) preprocessor and extract information about SSL version and session state from packets in an encrypted session. 
 
     [bookmark: pgfId-2867383]When a client and server communicate to establish an encrypted session using SSL or Transport Layer Security (TLS), they exchange handshake messages. Although the data transmitted in the session is encrypted, the handshake messages are not. 
 
     [bookmark: pgfId-2867384]The SSL preprocessor extracts state and version information from specific handshake fields. Two fields within the handshake indicate the version of SSL or TLS used to encrypt the session and the stage of the handshake.
 
     [bookmark: pgfId-2867401]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-2867405]ssl_state
 
      	 [bookmark: pgfId-2867409]ssl_version
 
     
 
    
 
     
      [bookmark: pgfId-2867411][bookmark: 76982]ssl_state
 
     [bookmark: pgfId-4238683]License: Protection
 
     [bookmark: pgfId-2867422]The ssl_state[bookmark: marker-3099249] keyword can be used to match against state information for an encrypted session. To check for two or more SSL versions used simultaneously, use multiple ssl_version keywords in a rule.
 
     [bookmark: pgfId-4225142]When a rule uses the ssl_state keyword, the rules engine invokes the SSL preprocessor to check traffic for SSL state information.
 
     [bookmark: pgfId-2867423]For example, to detect an attacker’s attempt to cause a buffer overflow on a server by sending a ClientHello message with an overly long challenge length and too much data, you could use the ssl_state keyword with client_hello as an argument then check for abnormally large packets. 
 
     [bookmark: pgfId-2867424]Use a comma-separated list to specify multiple arguments for the SSL state. When you list multiple arguments, the system evaluates them using the OR operator. For example, if you specify client_hello and server_hello as arguments, the system evaluates the rule against traffic that has a client_hello OR a server_hello.
 
     [bookmark: pgfId-3799799]You can also negate any argument; for example:
 
      
      [bookmark: pgfId-4028151]!client_hello, !unknown 
     
 
     [bookmark: pgfId-4028166]To ensure the connection has reached each of a set of states, multiple rules using the ssl_state rule option should be used. The ssl_state keyword takes the following identifiers as arguments:
 
     [bookmark: pgfId-2867460]
 
      
       
        
        [bookmark: pgfId-2867437]Table 36-34 ssl_state Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-2867441]Argument 
          
  
         	 
           
           [bookmark: pgfId-2867443]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-2867445]client_hello
  
         	[bookmark: pgfId-2867447]Matches against a handshake message with ClientHello as the message type, where the client requests an encrypted session.
  
        
 
         
         	[bookmark: pgfId-2867449]server_hello
  
         	[bookmark: pgfId-2867451]Matches against a handshake message with ServerHello as the message type, where the server responds to the client’s request for an encrypted session.
  
        
 
         
         	[bookmark: pgfId-2867453]client_keyx
  
         	[bookmark: pgfId-2867455]Matches against a handshake message with ClientKeyExchange as the message type, where the client transmits a key to the server to confirm receipt of a key from the server.
  
        
 
         
         	[bookmark: pgfId-2867457]server_keyx
  
         	[bookmark: pgfId-2867459]Matches against a handshake message with ServerKeyExchange as the message type, where the client transmits a key to the server to confirm receipt of a key from the server.
  
        
 
         
         	[bookmark: pgfId-2868972]unknown
  
         	[bookmark: pgfId-2868974]Matches against any handshake message type.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2867462][bookmark: 89100]ssl_version
 
     [bookmark: pgfId-4238700]License: Protection
 
     [bookmark: pgfId-2867473]The ssl_version[bookmark: marker-3099250] keyword can be used to match against version information for an encrypted session. When a rule uses the ssl_version keyword, the rules engine invokes the SSL preprocessor to check traffic for SSL version information.
 
     [bookmark: pgfId-2867474]For example, if you know there is a buffer overflow vulnerability in SSL version 2, you could use the ssl_version keyword with the sslv2 argument to identify traffic using that version of SSL.
 
     [bookmark: pgfId-4903200]Use a comma-separated list to specify multiple arguments for the SSL version. When you list multiple arguments, the system evaluates them using the OR operator. For example, if you wanted to identify any encrypted traffic that was not using SSLv2, you could add ssl_version:ssl_v3,tls1.0,tls1.1,tls1.2 to a rule. The rule would evaluate any traffic using SSL Version 3, TLS Version 1.0, TLS Version 1.1, or TLS Version 1.2.
 
     [bookmark: pgfId-4903205]The ssl_version keyword takes the following SSL/TLS version identifiers as arguments:
 
     [bookmark: pgfId-4903238]
 
      
       
        
        [bookmark: pgfId-4903211]Table 36-35 ssl_version Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4903215]Argument 
          
  
         	 
           
           [bookmark: pgfId-4903217]Purpose 
          
  
        
 
         
         	[bookmark: pgfId-4903219]sslv2
  
         	[bookmark: pgfId-4903221]Matches against traffic encoded using Secure Sockets Layer (SSL) Version 2. 
  
        
 
         
         	[bookmark: pgfId-4903223]sslv3
  
         	[bookmark: pgfId-4903225]Matches against traffic encoded using Secure Sockets Layer (SSL) Version 3. 
  
        
 
         
         	[bookmark: pgfId-4903227]tls1.0
  
         	[bookmark: pgfId-4903229]Matches against traffic encoded using Transport Layer Security (TLS) Version 1.0. 
  
        
 
         
         	[bookmark: pgfId-4903231]tls1.1
  
         	[bookmark: pgfId-4903233]Matches against traffic encoded using Transport Layer Security (TLS) Version 1.1. 
  
        
 
         
         	[bookmark: pgfId-4903235]tls1.2
  
         	[bookmark: pgfId-4903237]Matches against traffic encoded using Transport Layer Security (TLS) Version 1.2. 
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3839363][bookmark: 34917]Inspecting Application Layer Protocol Values
 
     [bookmark: pgfId-4238713]License: Protection
 
     [bookmark: pgfId-1064782]Although preprocessors perform most of the normalization and inspection of application layer protocol values, you can continue to inspect application layer values using the keywords described in the following sections:
 
      
      	 [bookmark: pgfId-1232928]RPC
 
      	 [bookmark: pgfId-2627722]ASN.1
 
      	 [bookmark: pgfId-1522891]urilen
 
      	 [bookmark: pgfId-4214956]DCE/RPC Keywords
 
      	 [bookmark: pgfId-4252181]SIP Keywords
 
      	 [bookmark: pgfId-4360101]GTP Keywords
 
      	 [bookmark: pgfId-4360154]Modbus Keywords
 
      	 [bookmark: pgfId-3300962]DNP3 Keywords
 
     
 
    
 
     
      [bookmark: pgfId-1064784][bookmark: 53217]RP[bookmark: marker-2606546]C
 
     [bookmark: pgfId-4238730]License: Protection
 
      
       
        
        [bookmark: pgfId-1447598]Table 36-36 [bookmark: 51776]rpc Keyword Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1079606]Argument 
          
  
         	 
           
           [bookmark: pgfId-1079608]Description 
          
  
        
 
         
         	[bookmark: pgfId-1079610]application
  
         	[bookmark: pgfId-1079612]The RPC application number
  
        
 
         
         	[bookmark: pgfId-1079614]procedure
  
         	[bookmark: pgfId-1079616]The RPC procedure invoked
  
        
 
         
         	[bookmark: pgfId-1079618]version
  
         	[bookmark: pgfId-1079620]The RPC version
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1064785]To specify the arguments for the rpc keyword, use the following syntax:
 
      
      [bookmark: pgfId-1079683]application,procedure,version 
     
 
     [bookmark: pgfId-1153920]where application is the RPC application number, procedure is the RPC procedure number, and version is the RPC version number. You must specify all arguments for the rpc keyword — if you are not able to specify one of the arguments, replace it with an asterisk (*).
 
     [bookmark: pgfId-4009252]For example, to search for RPC portmapper (which is the RPC application indicated by the number 100000), with any procedure or version, use 100000,*,* as the arguments. 
 
    
 
     
      [bookmark: pgfId-1522860][bookmark: 98752]AS[bookmark: marker-2606542]N.1
 
     [bookmark: pgfId-4238747]License: Protection
 
     [bookmark: pgfId-1522882]The asn1 keyword allows you to decode a packet or a portion of a packet, looking for various malicious encodings.
 
     [bookmark: pgfId-1522917]The following table describes the arguments for the asn1 keyword.
 
     [bookmark: pgfId-1525388]
 
      
       
        
        [bookmark: pgfId-1525391]Table 36-37 [bookmark: 87352]asn.1 Keyword Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1525395]Argument 
          
  
         	 
           
           [bookmark: pgfId-1525397]Description 
          
  
        
 
         
         	[bookmark: pgfId-1525399]Bitstring Overflow
  
         	[bookmark: pgfId-1525492]Detects invalid, remotely exploitable bitstring encodings.
  
        
 
         
         	[bookmark: pgfId-1525403]Double Overflow
  
         	[bookmark: pgfId-1525641]Detects a double ASCII encoding that is larger than a standard buffer. This is known to be an exploitable function in Microsoft Windows, but it is unknown at this time which services may be exploitable.
  
        
 
         
         	[bookmark: pgfId-1525407]Oversize Length
  
         	[bookmark: pgfId-1525699]Detects ASN.1 type lengths greater than the supplied argument. For example, if you set the Oversize Length to 500, any ASN.1 type greater than 500 triggers the rule.
  
        
 
         
         	[bookmark: pgfId-1525411]Absolute Offset
  
         	[bookmark: pgfId-1525730]Sets an absolute offset from the beginning of the packet payload. (Remember that the offset counter starts at byte 0.) For example, if you want to decode SNMP packets, set Absolute Offset to 0 and do not set a Relative Offset. Absolute Offset may be positive or negative.
  
        
 
         
         	[bookmark: pgfId-1525415]Relative Offset
  
         	[bookmark: pgfId-1525762]This is the relative offset from the last successful content match, pcre, or byte_jump. To decode an ASN.1 sequence right after the content "foo", set Relative Offset to 0, and do not set an Absolute Offset. Relative Offset may be positive or negative. (Remember that the offset counter starts at 0.) 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1526756]For example, there is a known vulnerability in the Microsoft ASN.1 Library that creates a buffer overflow, allowing an attacker to exploit the condition with a specially crafted authentication packet. When the system decodes the asn.1 data, exploit code in the packet could execute on the host with system-level privileges or could cause a DoS condition. The following rule uses the asn1 keyword to detect attempts to exploit this vulnerability:
 
      
      [bookmark: pgfId-1526757]alert tcp $EXTERNAL_NET any -> $HOME_NET 445
(flow:to_server, established; content:”|FF|SMB|73|”; nocase;
offset:4; depth:5;
asn1:bitstring_overflow,double_overflow,oversize_length
100,relative_offset 54;) 
     
 
     [bookmark: pgfId-1526829]The above rule generates an event against TCP traffic traveling from any IP address defined in the $EXTERNAL_NET variable, from any port, to any IP address defined in the $HOME_NET variable using port 445. In addition, it only executes the rule on established TCP connections to servers. The rule then tests for specific content in specific locations. Finally, the rule uses the asn1 keyword to detect bitstring encodings and double ASCII encodings and to identify asn.1 type lengths over 100 bytes in length starting 55 bytes from the end of the last successful content match. (Remember that the offset counter starts at byte 0.)
 
    
 
     
      [bookmark: pgfId-2626073][bookmark: 98448]urilen
 
     [bookmark: pgfId-4238760]License: Protection
 
     [bookmark: pgfId-2627411]You can use the [bookmark: marker-2644140]urilen keyword in conjunction with the HTTP Inspect preprocessor to inspect HTTP traffic for URIs of a specific length, less than a maximum length, greater than a minimum length, or within a specified range.
 
     [bookmark: pgfId-2631888]After the HTTP Inspect preprocessor normalizes and inspects the packet, the rules engine evaluates the packet against the rule and determines whether the URI matches the length condition specified by the urilen keyword. You can use this keyword to detect exploits that attempt to take advantage of URI length vulnerabilities, for example, by creating a buffer overflow that allows the attacker to cause a DoS condition or execute code on the host with system-level privileges.
 
     [bookmark: pgfId-2670578]Note the following when using the urilen keyword in a rule:
 
      
      	 [bookmark: pgfId-2670579]In practice, you always use the  urilen keyword in combination with the  flow:established  keyword and one or more other keywords.
 
      	 [bookmark: pgfId-2670591]The rule protocol is always TCP. See Specifying Protocols for more information.
 
      	 [bookmark: pgfId-2670594]Target ports are always HTTP ports. See Defining Ports in Intrusion Rules and Optimizing Predefined Default Variables for more information.
 
     
 
     [bookmark: pgfId-2627447]You specify the URI length using a decimal number of bytes, less than (<) and greater than (>).
 
     [bookmark: pgfId-2626074]For example:
 
      
      	 [bookmark: pgfId-2632010]specify 5  to detect a URI 5 bytes long.
 
      	 [bookmark: pgfId-2632011]specify < 5  (separated by one space character) to detect a URI less than 5 bytes long.
 
      	 [bookmark: pgfId-2626607]specify > 5  (separated by one space character) to detect a URI greater than 5 bytes long.
 
      	 [bookmark: pgfId-2626608]specify 3 <> 5  (with one space character before and after  <> ) to detect a URI between 3 and 5 bytes long inclusive.
 
     
 
     [bookmark: pgfId-2627100]For example, there is a known vulnerability in Novell’s server monitoring and diagnostics utility iMonitor version 2.4, which comes with eDirectory version 8.8. A packet containing an excessively long URI creates a buffer overflow, allowing an attacker to exploit the condition with a specially crafted packet that could execute on the host with system-level privileges or could cause a DoS condition. The following rule uses the urilen keyword to detect attempts to exploit this vulnerability:
 
      
      [bookmark: pgfId-2626978]alert tcp $EXTERNAL_NET any -> $HOME_NET $HTTP_PORTS
(msg:"EXPLOIT eDirectory 8.8 Long URI iMonitor buffer
overflow attempt";flow:to_server,established;
urilen:> 8192; uricontent:"/nds/"; nocase;
classtype:attempted-admin; sid:x; rev:1;) 
     
 
     [bookmark: pgfId-2626772]The above rule generates an event against TCP traffic traveling from any IP address defined in the $EXTERNAL_NET variable, from any port, to any IP address defined in the $HOME_NET variable using the ports defined in the $HTTP_PORTS variable. In addition, packets are evaluated against the rule only on established TCP connections to servers. The rule uses the urilen keyword to detect any URI over 8192 bytes in length. Finally, the rule searches the URI for the specific case-insensitive content /nds/.
 
    
 
     
      [bookmark: pgfId-3300998][bookmark: 55995]DCE/RPC Keywords
 
     [bookmark: pgfId-4238773]License: Protection
 
     [bookmark: pgfId-3301015]The three DCE/RPC keywords described in the following table allow you to monitor DCE/RPC session traffic for exploits. When the system processes rules with these keywords, it invokes the DCE/RPC preprocessor. See Decoding DCE/RPC Traffic for more information.
 
     [bookmark: pgfId-3301061]
 
      
       
        
        [bookmark: pgfId-4913639]Table 36-38 [bookmark: 82119]DCE/RPC Keywords 
 
        
        
         
         	 
           
           [bookmark: pgfId-4913645]Use... 
          
  
         	 
           
           [bookmark: pgfId-4913647]In this way... 
          
  
         	 
           
           [bookmark: pgfId-4913649]To detect... 
          
  
        
 
         
         	[bookmark: pgfId-4913651]dce_iface
  
         	[bookmark: pgfId-4913653]alone
  
         	[bookmark: pgfId-4913656]packets identifying a specific DCE/RPC service
  
        
 
         
         	[bookmark: pgfId-4913658]dce_opnum
  
         	[bookmark: pgfId-4913660]preceded by dce_iface
  
         	[bookmark: pgfId-4913663]packets identifying specific DCE/RPC service operations
  
        
 
         
         	[bookmark: pgfId-4913665]dce_stub_data
  
         	[bookmark: pgfId-4913667]preceded by dce_iface + dce_opnum
  
         	[bookmark: pgfId-4913669]stub data defining a specific operation request or response
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3301062]Note in the table that you should always precede dce_opnum with dce_iface, and you should always precede dce_stub_data with dce_iface + dce_opnum.
 
     [bookmark: pgfId-3301063]You can also use these DCE/RPC keywords in combination with other rule keywords. Note that for DCE/RPC rules, you use the byte_jump, byte_test, and byte_extract keywords with their DCE/RPC arguments selected. For more information, see Using Byte_Jump and Byte_Test and Reading Packet Data into Keyword Arguments.
 
     [bookmark: pgfId-3301070]Cisco recommends that you include at least one content keyword in rules that include DCE/RPC keywords to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Note that the rules engine uses the fast pattern matcher when a rule includes at least one content keyword, regardless of whether you enable the content keyword Use Fast Pattern Matcher argument. See Searching for Content Matches and Use Fast Pattern Matcher for more information.
 
     [bookmark: pgfId-3301077]You can use the DCE/RPC version and adjoining header information as the matching content in the following cases:
 
      
      	 [bookmark: pgfId-3301078]the rule does not include another  content keyword
 
      	 [bookmark: pgfId-3301079]the rule contains another  content keyword, but the DCE/RPC version and adjoining information represent a more unique pattern than the other content
 
     
 
     [bookmark: pgfId-3301080]For example, the DCE/RPC version and adjoining information are more likely to be unique than a single byte of content.
 
     [bookmark: pgfId-3301081]You should end qualifying rules with one of the following version and adjoining information content matches:
 
      
      	 [bookmark: pgfId-3301082]For connection-oriented DCE/RPC rules, use the content  |05 00 00| (for major version 05, minor version 00, and the request PDU (protocol data unit) type 00).
 
      	 [bookmark: pgfId-3301083]For connectionless DCE/RPC rules, use the content  |04 00| (for version 04, and the request PDU type 00).
 
     
 
     [bookmark: pgfId-3301084]In either case, position the content keyword for version and adjoining information as the last keyword in the rule to invoke the fast pattern matcher without repeating processing already completed by the DCE/RPC preprocessor. Note that placing the content keyword at the end of the rule applies to version content used as a device to invoke the fast pattern matcher, and not necessarily to other content matches in the rule.
 
     [bookmark: pgfId-3301085]See the following sections for more information:
 
      
      	 [bookmark: pgfId-3301089]dce_iface
 
      	 [bookmark: pgfId-3301093]dce_opnum
 
      	 [bookmark: pgfId-3301097]dce_stub_data
 
     
 
    
 
     
      [bookmark: pgfId-3301099][bookmark: 19395]dce_iface
 
     [bookmark: pgfId-4390621]License: Protection
 
     [bookmark: pgfId-4390659]You can use the dce_iface[bookmark: marker-4390660] keyword to identify a specific DCE/RPC service.
 
     [bookmark: pgfId-3301105]Optionally, you can also use dce_iface in combination with the dce_opnum and dce_stub_data keywords to further limit the DCE/RPC traffic to inspect. See dce_opnum and dce_stub_data for more information.
 
     [bookmark: pgfId-3301116]A fixed, sixteen-byte Universally Unique Identifier (UUID) identifies the application interface assigned to each DCE/RPC service. For example, the UUID 4b324fc8-670-01d3-1278-5a47bf6ee188 identifies the DCE/RPC lanmanserver service, also known as the srvsvc service, which provides numerous management functions for sharing peer-to-peer printers, files, and SMB named pipes. The DCE/RPC preprocessor uses the UUID and associated header values to track DCE/RPC sessions.
 
     [bookmark: pgfId-3301117]The interface UUID is comprised of five hexadecimal strings separated by hyphens:
 
      
      [bookmark: pgfId-3301118]<4hexbytes>-<2hexbytes>-<2hexbytes>-<2hexbytes>-<6hexbytes> 
     
 
     [bookmark: pgfId-3301119]You specify the interface by entering the entire UUID including hyphens, as seen in the following UUID for the netlogon interface:
 
      
      [bookmark: pgfId-3301120]12345678-1234-abcd-ef00-01234567cffb 
     
 
     [bookmark: pgfId-3301121]Note that you must specify the first three strings in the UUID in big endian byte order. Although published interface listings and protocol analyzers typically display UUIDs in the correct byte order, you might encounter a need to rearrange the UUID byte order before entering it. Consider the following messenger service UUID shown as it might sometimes be displayed in raw ASCII text with the first three strings in little endian byte order:
 
      
      [bookmark: pgfId-3301122]f8 91 7b 5a 00 ff d0 11 a9 b2 00 c0 4f b6 e6 fc 
     
 
     [bookmark: pgfId-3301123]You would specify the same UUID for the dce_iface keyword by inserting hyphens and putting the first three strings in big endian byte order as follows:
 
      
      [bookmark: pgfId-3301124]5a7b91f8-ff00-11d0-a9b2-00c04fb6e6fc 
     
 
     [bookmark: pgfId-3301125]Although a DCE/RPC session can include requests to multiple interfaces, you should include only one dce_iface keyword in a rule. Create additional rules to detect additional interfaces.
 
     [bookmark: pgfId-3301126]DCE/RPC application interfaces also have interface version numbers. You can optionally specify an interface version with an operator indicating that the version equals, does not equal, is less than, or greater than the specified value.
 
     [bookmark: pgfId-3301127]Both connection-oriented and connectionless DCE/RPC can be fragmented in addition to any TCP segmentation or IP fragmentation. Typically, it is not useful to associate any DCE/RPC fragment other than the first with the specified interface, and doing so may result in a large number of false positives. However, for flexibility you can optionally evaluate all fragments against the specified interface.
 
      
       
        
        [bookmark: pgfId-4913695]Table 36-39 dce_iface[bookmark: 59341] Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4913699]Argument 
          
  
         	 
           
           [bookmark: pgfId-4913701]Description 
          
  
        
 
         
         	[bookmark: pgfId-4913703]Interface UUID
  
         	[bookmark: pgfId-4913705]The UUID, including hyphens, that identifies the application interface of the specific service that you want to detect in DCE/RPC traffic. Any request associated with the specified interface would match the interface UUID.
  
        
 
         
         	[bookmark: pgfId-4913707]Version
  
         	[bookmark: pgfId-4913709]Optionally, the application interface version number 0 to 65535 and an operator indicating whether to detect a version greater than (>), less than (<), equal to (=), or not equal to (!) the specified value.
  
        
 
         
         	[bookmark: pgfId-4913711]All Fragments
  
         	[bookmark: pgfId-4913713]Optionally, enable to match against the interface in all associated DCE/RPC fragments and, if specified, on the interface version. This argument is disabled by default, indicating that the keyword matches only if the first fragment or the entire unfragmented packet is associated with the specified interface. Note that enabling this argument may result in false positives.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3301159][bookmark: 37246]dce_opnum
 
     [bookmark: pgfId-4238802]License: Protection
 
     [bookmark: pgfId-4214994]You can use the dce_opnum[bookmark: marker-4214997] keyword in conjunction with the DCE/RPC preprocessor to detect packets that identify one or more specific operations that a DCE/RPC service provides.
 
     [bookmark: pgfId-3301165]Client function calls request specific service functions, which are referred to in DCE/RPC specifications as operations. An operation number (opnum) identifies a specific operation in the DCE/RPC header. It is likely that an exploit would target a specific operation.
 
     [bookmark: pgfId-3301166]For example, the UUID 12345678-1234-abcd-ef00-01234567cffb identifies the interface for the netlogon service, which provides several dozen different operations. One of these is operation 6, the NetrServerPasswordSet operation.
 
     [bookmark: pgfId-3301167]You should precede a dce_opnum keyword with a dce_iface keyword to identify the service for the operation. See dce_iface for more information.
 
     [bookmark: pgfId-3301175]You can specify a single decimal value 0 to 65535 for a specific operation, a range of operations separated by a hyphen, or a comma-separated list of operations and ranges in any order.
 
     [bookmark: pgfId-3301176]Any of the following examples would specify valid netlogon operation numbers:
 
      
      [bookmark: pgfId-3301177]15 
     
 
      
      [bookmark: pgfId-3301178]15-18 
     
 
      
      [bookmark: pgfId-3301179]15, 18-20 
     
 
      
      [bookmark: pgfId-3301180]15, 20-22, 17 
     
 
      
      [bookmark: pgfId-3301181]15, 18-20, 22, 24-26 
     
 
    
 
     
      [bookmark: pgfId-3301183][bookmark: 47348]dce_stub_data
 
     [bookmark: pgfId-4238821]License: Protection
 
     [bookmark: pgfId-3301184]You can use the dce_stub_data[bookmark: marker-4215002] keyword in conjunction with the DCE/RPC preprocessor to specify that the rules engine should start inspection at the beginning of the stub data, regardless of any other rule options. Packet payload rule options that follow the dce_stub_data keyword are applied relative to the stub data buffer.
 
     [bookmark: pgfId-4390195]DCE/RPC stub data provides the interface between a client procedure call and the DCE/RPC run-time system, the mechanism that provides the routines and services central to DCE/RPC. DCE/RPC exploits are identified in the stub data portion of the DCE/RPC packet. Because stub data is associated with a specific operation or function call, you should always precede dce_stub_data with dce_iface and dce_opnum to identify the related service and operation. 
 
     [bookmark: pgfId-4214236]The dce_stub_data keyword has no arguments. See dce_iface and dce_opnum for more information.
 
    
 
     
      [bookmark: pgfId-4214608][bookmark: 75688]SIP Keywords
 
     [bookmark: pgfId-4238836]License: Protection
 
     [bookmark: pgfId-4214623]Four SIP keywords allow you to monitor SIP session traffic for exploits. 
 
     [bookmark: pgfId-4214624]Note that the SIP protocol is vulnerable to denial of service (DoS) attacks. Rules addressing these attacks can benefit from rate-based attack prevention. See Adding Dynamic Rule States and Preventing Rate-Based Attacks for more information.
 
     [bookmark: pgfId-4214631]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4214634]sip_header
 
      	 [bookmark: pgfId-4214638]sip_body
 
      	 [bookmark: pgfId-4214642]sip_method
 
      	 [bookmark: pgfId-4214646]sip_stat_code
 
     
 
    
 
     
      [bookmark: pgfId-4214649][bookmark: 94104]sip_header
 
     [bookmark: pgfId-4238849]License: Protection
 
     [bookmark: pgfId-4214664]You can use the sip_header[bookmark: marker-4215009] keyword to start inspection at the beginning of the extracted SIP request or response header and restrict inspection to header fields.
 
     [bookmark: pgfId-4214668]The sip_header keyword has no arguments. See sip_method and sip_stat_code for more information.
 
     [bookmark: pgfId-4214673]The following example rule fragment points to the SIP header and matches the CSeq header field:
 
      
      [bookmark: pgfId-4214674]alert udp any any -> any 5060 ( sip_header; content:"CSeq"; ) 
     
 
    
 
     
      [bookmark: pgfId-4214680][bookmark: 87084]sip_body
 
     [bookmark: pgfId-4238863]License: Protection
 
     [bookmark: pgfId-4214695]You can use the sip_body[bookmark: marker-4215014] keyword to start inspection at the beginning of the extracted SIP request or response message body and restrict inspection to the message body.
 
     [bookmark: pgfId-4214697]The sip_body keyword has no arguments.
 
     [bookmark: pgfId-4214698]The following example rule fragment points to the SIP message body and matches a specific IP address in the c (connection information) field in extracted SDP data:
 
      
      [bookmark: pgfId-4214699]alert udp any any -> any 5060 ( sip_body; content:"c=IN 192.168.12.14"; ) 
     
 
     [bookmark: pgfId-4214700]Note that rules are not limited to searching for SDP content. The SIP preprocessor extracts the entire message body and makes it available to the rules engine.
 
    
 
     
      [bookmark: pgfId-4214706][bookmark: 23041]sip_method
 
     [bookmark: pgfId-4238877]License: Protection
 
     [bookmark: pgfId-4215031]A method field in each SIP request identifies the purpose of the request. You can use the sip_method[bookmark: marker-4215034] keyword to test SIP requests for specific methods. Separate multiple methods with commas.
 
     [bookmark: pgfId-4214723]You can specify any of the following currently defined SIP methods:
 
      
      [bookmark: pgfId-4385723]ack, benotify, bye, cancel, do, info, invite, join, message, notify, options, prack, publish, quath, refer, register, service, sprack, subscribe, unsubscribe, update 
     
 
     [bookmark: pgfId-4385730]Methods are case-insensitive. You can separate multiple methods with commas.
 
     [bookmark: pgfId-4214726]Because new SIP methods might be defined in the future, you can also specify a custom method, that is, a method that is not a currently defined SIP method. Accepted field values are defined in RFC 2616, which allows all characters except control characters and separators such as =, (, and }. See RFC 2616 for the complete list of excluded separators. When the system encounters a specified custom method in traffic, it will inspect the packet header but not the message.
 
     [bookmark: pgfId-4234019]The system supports up to 32 methods, including the 21 currently defined methods and an additional 11 methods. The system ignores any undefined methods that you might configure. Note that the 32 total methods includes methods specified using the Methods to Check SIP preprocessor option. See Selecting SIP Preprocessor Options for more information.
 
     [bookmark: pgfId-4233966]You can specify only one method when you use negation. For example:
 
      
      [bookmark: pgfId-4214731]!invite 
     
 
     [bookmark: pgfId-4214732]Note, however, that multiple sip_method keywords in a rule are linked with an AND operation. For example, to test for all extracted methods except invite and cancel, you would use two negated sip_method keywords:
 
      
      [bookmark: pgfId-4214733]sip_method: !invite 
     
 
      
      [bookmark: pgfId-4214734]sip_method: !cancel 
     
 
     [bookmark: pgfId-4214741]Cisco recommends that you include at least one content keyword in rules that include the sip_method keyword to ensure that the rules engine uses the fast pattern matcher, which increases processing speed and improves performance. Note that the rules engine uses the fast pattern matcher when a rule includes at least one content keyword, regardless of whether you enable the content keyword Use Fast Pattern Matcher argument. See Searching for Content Matches and Use Fast Pattern Matcher for more information.
 
    
 
     
      [bookmark: pgfId-4214750][bookmark: 89845]sip_stat_code
 
     [bookmark: pgfId-4238891]License: Protection
 
     [bookmark: pgfId-4214765]A three-digit status code in each SIP response indicates the outcome of the requested action. You can use the sip_stat_code[bookmark: marker-4215039] keyword to test SIP responses for specific status codes.
 
     [bookmark: pgfId-4214767]You can specify a one-digit response-type number 1-9, a specific three-digit number 100-999, or a comma-separated list of any combination of either. A list matches if any single number in the list matches the code in the SIP response.
 
     [bookmark: pgfId-4214768]The following table describes the SIP status code values you can specify.
 
     [bookmark: pgfId-4214813]
 
      
       
        
        [bookmark: pgfId-4913801]Table 36-40 sip_stat_code Values 
 
        
        
         
         	 
           
           [bookmark: pgfId-4913809]To detect... 
          
  
         	 
           
           [bookmark: pgfId-4913811]Specify... 
          
  
         	 
           
           [bookmark: pgfId-4913813]For example... 
          
  
         	 
           
           [bookmark: pgfId-4913815]Detects... 
          
  
        
 
         
         	[bookmark: pgfId-4913817]a specific status code
  
         	[bookmark: pgfId-4913819]the three-digit status code
  
         	[bookmark: pgfId-4913821]189
  
         	[bookmark: pgfId-4913823]189
  
        
 
         
         	[bookmark: pgfId-4913825]any three-digit code that begins with a specified single digit
  
         	[bookmark: pgfId-4913827]the single digit
  
         	[bookmark: pgfId-4913829]1
  
         	[bookmark: pgfId-4913831]1xx; that is, 100, 101, 102, and so on
  
        
 
         
         	[bookmark: pgfId-4913833]a list of values
  
         	[bookmark: pgfId-4913835]any comma-separated combination of specific codes and single digits
  
         	[bookmark: pgfId-4913837]222, 3
  
         	[bookmark: pgfId-4913839]222 plus 300, 301, 302, and so on
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4214240]Note also that the rules engine does not use the fast pattern matcher to search for the value specify using the sip_stat_code keyword, regardless of whether your rule includes a content keyword.
 
    
 
     
      [bookmark: pgfId-4251886][bookmark: 57773]GTP Keywords
 
     [bookmark: pgfId-4251972]License: Protection
 
     [bookmark: pgfId-4251906]Three GSRP Tunneling Protocol (GTP) keywords allow you to inspect the GTP command channel for GTP version, message type, and information elements. You cannot use GTP keywords in combination with other intrusion rule keywords such as content or byte_jump. You must use the gtp_version keyword in each rule that uses the gtp_info or gtp_type keyword.
 
     [bookmark: pgfId-4252224]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4373018]gtp_version
 
      	 [bookmark: pgfId-4373048]gtp_type
 
      	 [bookmark: pgfId-4373052]gtp_info
 
     
 
    
 
     
      [bookmark: pgfId-4373054][bookmark: 86989]gtp_ver[bookmark: marker-4517609]sion
 
     [bookmark: pgfId-4351680]You can use the gtp_version keyword to inspect GTP control messages for GTP version 0, 1, or 2.
 
     [bookmark: pgfId-4351685]Because different GTP versions define different message types and information elements, you must use this keyword when you use the gtp_type or gtp_info keyword. You can specify the value 0, 1, or 2.
 
     [bookmark: pgfId-4375995]To specify the GTP version:
 
     [bookmark: pgfId-4375996]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4375997]Step 1 On the Create Rule page, select gtp_version in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4375998]The gtp_version keyword appears.
 
     [bookmark: pgfId-4376003]Step 2 Specify 0, 1, or 2 to identify the GTP version.
 
     [bookmark: pgfId-4776228]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4352215][bookmark: 25524]gtp_ty[bookmark: marker-4399758]pe
 
     [bookmark: pgfId-4352216]Each GTP message is identified by a message type, which is comprised of both a numeric value and a string. You can use the gtp_type keyword in combination with the gtp_version keyword to inspect traffic for specific GTP message types.
 
     [bookmark: pgfId-4352221]You can specify a defined decimal value for a message type, a defined string, or a comma-separated list of either or both in any combination, as seen in the following example:
 
      
      [bookmark: pgfId-4352225]10, 11, echo_request 
     
 
     [bookmark: pgfId-4352226]The system uses an OR operation to match each value or string that you list. The order in which you list values and strings does not matter. Any single value or string in the list matches the keyword. You receive an error if you attempt to save a rule that includes an unrecognized string or an out-of-range value.
 
     [bookmark: pgfId-4352227]Note in the table that different GTP versions sometimes use different values for the same message type. For example, the sgsn_context_request message type has a value of 50 in GTPv0 and GTPv1, but a value of 130 in GTPv2.
 
     [bookmark: pgfId-4352228]The gtp_type keyword matches different values depending on the version number in the packet. In the example above, the keyword matches the message type value 50 in a GTPv0 or GTPv1 packet and the value 130 in a GTPv2 packet. The keyword does not match a packet when the message type value in the packet is not a known value for the version specified in the packet.
 
     [bookmark: pgfId-4352229]If you specify an integer for the message type, the keyword matches if the message type in the keyword matches the value in the GTP packet, regardless of the version specified in the packet.
 
     [bookmark: pgfId-4353899]The following table lists the defined values and strings recognized by the system for each GTP message type.
 
     [bookmark: pgfId-4645550]
 
      
       
        
        [bookmark: pgfId-4646773]Table 36-41 [bookmark: 69034]GTP Message Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-4646781]Value 
          
  
         	 
           
           [bookmark: pgfId-4646783]Version 0 
          
  
         	 
           
           [bookmark: pgfId-4646785]Version 1 
          
  
         	 
           
           [bookmark: pgfId-4646787]Version 2 
          
  
        
 
         
         	[bookmark: pgfId-4646789]1
  
         	[bookmark: pgfId-4646791]echo_request
  
         	[bookmark: pgfId-4646793]echo_request
  
         	[bookmark: pgfId-4646795]echo_request
  
        
 
         
         	[bookmark: pgfId-4646797]2
  
         	[bookmark: pgfId-4646799]echo_response
  
         	[bookmark: pgfId-4646801]echo_response
  
         	[bookmark: pgfId-4646803]echo_response
  
        
 
         
         	[bookmark: pgfId-4646805]3
  
         	[bookmark: pgfId-4646807]version_not_supported
  
         	[bookmark: pgfId-4646809]version_not_supported
  
         	[bookmark: pgfId-4646811]version_not_supported
  
        
 
         
         	[bookmark: pgfId-4646813]4
  
         	[bookmark: pgfId-4646815]node_alive_request
  
         	[bookmark: pgfId-4646817]node_alive_request
  
         	[bookmark: pgfId-4646819]N/A
  
        
 
         
         	[bookmark: pgfId-4646821]5
  
         	[bookmark: pgfId-4646823]node_alive_response
  
         	[bookmark: pgfId-4646825]node_alive_response
  
         	[bookmark: pgfId-4646827]N/A
  
        
 
         
         	[bookmark: pgfId-4646829]6
  
         	[bookmark: pgfId-4646831]redirection_request
  
         	[bookmark: pgfId-4646833]redirection_request
  
         	[bookmark: pgfId-4646835]N/A
  
        
 
         
         	[bookmark: pgfId-4646837]7
  
         	[bookmark: pgfId-4646839]redirection_response
  
         	[bookmark: pgfId-4646841]redirection_response
  
         	[bookmark: pgfId-4646843]N/A
  
        
 
         
         	[bookmark: pgfId-4646845]16
  
         	[bookmark: pgfId-4646847]create_pdp_context_request
  
         	[bookmark: pgfId-4646849]create_pdp_context_request
  
         	[bookmark: pgfId-4646851]N/A
  
        
 
         
         	[bookmark: pgfId-4646853]17
  
         	[bookmark: pgfId-4646855]create_pdp_context_response
  
         	[bookmark: pgfId-4646857]create_pdp_context_response
  
         	[bookmark: pgfId-4646859]N/A
  
        
 
         
         	[bookmark: pgfId-4646861]18
  
         	[bookmark: pgfId-4646863]update_pdp_context_request
  
         	[bookmark: pgfId-4646865]update_pdp_context_request
  
         	[bookmark: pgfId-4646867]N/A
  
        
 
         
         	[bookmark: pgfId-4646869]19
  
         	[bookmark: pgfId-4646871]update_pdp_context_response
  
         	[bookmark: pgfId-4646873]update_pdp_context_response
  
         	[bookmark: pgfId-4646875]N/A
  
        
 
         
         	[bookmark: pgfId-4646877]20
  
         	[bookmark: pgfId-4646879]delete_pdp_context_request
  
         	[bookmark: pgfId-4646881]delete_pdp_context_request
  
         	[bookmark: pgfId-4646883]N/A
  
        
 
         
         	[bookmark: pgfId-4646885]21
  
         	[bookmark: pgfId-4646887]delete_pdp_context_response
  
         	[bookmark: pgfId-4646889]delete_pdp_context_response
  
         	[bookmark: pgfId-4646891]N/A
  
        
 
         
         	[bookmark: pgfId-4646893]22
  
         	[bookmark: pgfId-4646895]create_aa_pdp_context_request
  
         	[bookmark: pgfId-4646897]init_pdp_context_activation_request
  
         	[bookmark: pgfId-4646899]N/A
  
        
 
         
         	[bookmark: pgfId-4646901]23
  
         	[bookmark: pgfId-4646903]create_aa_pdp_context_response
  
         	[bookmark: pgfId-4646905]init_pdp_context_activation_response
  
         	[bookmark: pgfId-4646907]N/A
  
        
 
         
         	[bookmark: pgfId-4646909]24
  
         	[bookmark: pgfId-4646911]delete_aa_pdp_context_request
  
         	[bookmark: pgfId-4646913]N/A
  
         	[bookmark: pgfId-4646915]N/A
  
        
 
         
         	[bookmark: pgfId-4646917]25
  
         	[bookmark: pgfId-4646919]delete_aa_pdp_context_response
  
         	[bookmark: pgfId-4646921]N/A
  
         	[bookmark: pgfId-4646923]N/A
  
        
 
         
         	[bookmark: pgfId-4646925]26
  
         	[bookmark: pgfId-4646927]error_indication
  
         	[bookmark: pgfId-4646929]error_indication
  
         	[bookmark: pgfId-4646931]N/A
  
        
 
         
         	[bookmark: pgfId-4646933]27
  
         	[bookmark: pgfId-4646935]pdu_notification_request
  
         	[bookmark: pgfId-4646937]pdu_notification_request
  
         	[bookmark: pgfId-4646939]N/A
  
        
 
         
         	[bookmark: pgfId-4646941]28
  
         	[bookmark: pgfId-4646943]pdu_notification_response
  
         	[bookmark: pgfId-4646945]pdu_notification_response
  
         	[bookmark: pgfId-4646947]N/A
  
        
 
         
         	[bookmark: pgfId-4646949]29
  
         	[bookmark: pgfId-4646951]pdu_notification_reject_request
  
         	[bookmark: pgfId-4646953]pdu_notification_reject_request
  
         	[bookmark: pgfId-4646955]N/A
  
        
 
         
         	[bookmark: pgfId-4646957]30
  
         	[bookmark: pgfId-4646959]pdu_notification_reject_response
  
         	[bookmark: pgfId-4646961]pdu_notification_reject_response
  
         	[bookmark: pgfId-4646963]N/A
  
        
 
         
         	[bookmark: pgfId-4646965]31
  
         	[bookmark: pgfId-4646967]N/A
  
         	[bookmark: pgfId-4646969]supported_ext_header_notification
  
         	[bookmark: pgfId-4646971]N/A
  
        
 
         
         	[bookmark: pgfId-4646973]32
  
         	[bookmark: pgfId-4646975]send_routing_info_request
  
         	[bookmark: pgfId-4646977]send_routing_info_request
  
         	[bookmark: pgfId-4646979]create_session_request
  
        
 
         
         	[bookmark: pgfId-4646981]33
  
         	[bookmark: pgfId-4646983]send_routing_info_response
  
         	[bookmark: pgfId-4646985]send_routing_info_response
  
         	[bookmark: pgfId-4646987]create_session_response
  
        
 
         
         	[bookmark: pgfId-4646989]34
  
         	[bookmark: pgfId-4646991]failure_report_request
  
         	[bookmark: pgfId-4646993]failure_report_request
  
         	[bookmark: pgfId-4646995]modify_bearer_request
  
        
 
         
         	[bookmark: pgfId-4646997]35
  
         	[bookmark: pgfId-4646999]failure_report_response
  
         	[bookmark: pgfId-4647001]failure_report_response
  
         	[bookmark: pgfId-4647003]modify_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647005]36
  
         	[bookmark: pgfId-4647007]note_ms_present_request
  
         	[bookmark: pgfId-4647009]note_ms_present_request
  
         	[bookmark: pgfId-4647011]delete_session_request
  
        
 
         
         	[bookmark: pgfId-4647013]37
  
         	[bookmark: pgfId-4647015]note_ms_present_response
  
         	[bookmark: pgfId-4647017]note_ms_present_response
  
         	[bookmark: pgfId-4647019]delete_session_response
  
        
 
         
         	[bookmark: pgfId-4647021]38
  
         	[bookmark: pgfId-4647023]N/A
  
         	[bookmark: pgfId-4647025]N/A
  
         	[bookmark: pgfId-4647027]change_notification_request
  
        
 
         
         	[bookmark: pgfId-4647029]39
  
         	[bookmark: pgfId-4647031]N/A
  
         	[bookmark: pgfId-4647033]N/A
  
         	[bookmark: pgfId-4647035]change_notification_response
  
        
 
         
         	[bookmark: pgfId-4647037]48
  
         	[bookmark: pgfId-4647039]identification_request
  
         	[bookmark: pgfId-4647041]identification_request
  
         	[bookmark: pgfId-4647043]N/A
  
        
 
         
         	[bookmark: pgfId-4647045]49
  
         	[bookmark: pgfId-4647047]identification_response
  
         	[bookmark: pgfId-4647049]identification_response
  
         	[bookmark: pgfId-4647051]N/A
  
        
 
         
         	[bookmark: pgfId-4647053]50
  
         	[bookmark: pgfId-4647055]sgsn_context_request
  
         	[bookmark: pgfId-4647057]sgsn_context_request
  
         	[bookmark: pgfId-4647059]N/A
  
        
 
         
         	[bookmark: pgfId-4647061]51
  
         	[bookmark: pgfId-4647063]sgsn_context_response
  
         	[bookmark: pgfId-4647065]sgsn_context_response
  
         	[bookmark: pgfId-4647067]N/A
  
        
 
         
         	[bookmark: pgfId-4647069]52
  
         	[bookmark: pgfId-4647071]sgsn_context_ack
  
         	[bookmark: pgfId-4647073]sgsn_context_ack
  
         	[bookmark: pgfId-4647075]N/A
  
        
 
         
         	[bookmark: pgfId-4647077]53
  
         	[bookmark: pgfId-4647079]N/A
  
         	[bookmark: pgfId-4647081]forward_relocation_request
  
         	[bookmark: pgfId-4647083]N/A
  
        
 
         
         	[bookmark: pgfId-4647085]54
  
         	[bookmark: pgfId-4647087]N/A
  
         	[bookmark: pgfId-4647089]forward_relocation_response
  
         	[bookmark: pgfId-4647091]N/A
  
        
 
         
         	[bookmark: pgfId-4647093]55
  
         	[bookmark: pgfId-4647095]N/A
  
         	[bookmark: pgfId-4647097]forward_relocation_complete
  
         	[bookmark: pgfId-4647099]N/A
  
        
 
         
         	[bookmark: pgfId-4647101]56
  
         	[bookmark: pgfId-4647103]N/A
  
         	[bookmark: pgfId-4647105]relocation_cancel_request
  
         	[bookmark: pgfId-4647107]N/A
  
        
 
         
         	[bookmark: pgfId-4647109]57
  
         	[bookmark: pgfId-4647111]N/A
  
         	[bookmark: pgfId-4647113]relocation_cancel_response
  
         	[bookmark: pgfId-4647115]N/A
  
        
 
         
         	[bookmark: pgfId-4647117]58
  
         	[bookmark: pgfId-4647119]N/A
  
         	[bookmark: pgfId-4647121]forward_srns_contex
  
         	[bookmark: pgfId-4647123]N/A
  
        
 
         
         	[bookmark: pgfId-4647125]59
  
         	[bookmark: pgfId-4647127]N/A
  
         	[bookmark: pgfId-4647129]forward_relocation_complete_ack
  
         	[bookmark: pgfId-4647131]N/A
  
        
 
         
         	[bookmark: pgfId-4647133]60
  
         	[bookmark: pgfId-4647135]N/A
  
         	[bookmark: pgfId-4647137]forward_srns_contex_ack
  
         	[bookmark: pgfId-4647139]N/A
  
        
 
         
         	[bookmark: pgfId-4647141]64
  
         	[bookmark: pgfId-4647143]N/A
  
         	[bookmark: pgfId-4647145]N/A
  
         	[bookmark: pgfId-4647147]modify_bearer_command
  
        
 
         
         	[bookmark: pgfId-4647149]65
  
         	[bookmark: pgfId-4647151]N/A
  
         	[bookmark: pgfId-4647153]N/A
  
         	[bookmark: pgfId-4647155]modify_bearer_failure_indication
  
        
 
         
         	[bookmark: pgfId-4647157]66
  
         	[bookmark: pgfId-4647159]N/A
  
         	[bookmark: pgfId-4647161]N/A
  
         	[bookmark: pgfId-4647163]delete_bearer_command
  
        
 
         
         	[bookmark: pgfId-4647165]67
  
         	[bookmark: pgfId-4647167]N/A
  
         	[bookmark: pgfId-4647169]N/A
  
         	[bookmark: pgfId-4647171]delete_bearer_failure_indication
  
        
 
         
         	[bookmark: pgfId-4647173]68
  
         	[bookmark: pgfId-4647175]N/A
  
         	[bookmark: pgfId-4647177]N/A
  
         	[bookmark: pgfId-4647179]bearer_resource_command
  
        
 
         
         	[bookmark: pgfId-4647181]69
  
         	[bookmark: pgfId-4647183]N/A
  
         	[bookmark: pgfId-4647185]N/A
  
         	[bookmark: pgfId-4647187]bearer_resource_failure_indication
  
        
 
         
         	[bookmark: pgfId-4647189]70
  
         	[bookmark: pgfId-4647191]N/A
  
         	[bookmark: pgfId-4647193]ran_info_relay
  
         	[bookmark: pgfId-4647195]downlink_failure_indication
  
        
 
         
         	[bookmark: pgfId-4647197]71
  
         	[bookmark: pgfId-4647199]N/A
  
         	[bookmark: pgfId-4647201]N/A
  
         	[bookmark: pgfId-4647203]trace_session_activation
  
        
 
         
         	[bookmark: pgfId-4647205]72
  
         	[bookmark: pgfId-4647207]N/A
  
         	[bookmark: pgfId-4647209]N/A
  
         	[bookmark: pgfId-4647211]trace_session_deactivation
  
        
 
         
         	[bookmark: pgfId-4647213]73
  
         	[bookmark: pgfId-4647215]N/A
  
         	[bookmark: pgfId-4647217]N/A
  
         	[bookmark: pgfId-4647219]stop_paging_indication
  
        
 
         
         	[bookmark: pgfId-4647221]95
  
         	[bookmark: pgfId-4647223]N/A
  
         	[bookmark: pgfId-4647225]N/A
  
         	[bookmark: pgfId-4647227]create_bearer_request
  
        
 
         
         	[bookmark: pgfId-4647229]96
  
         	[bookmark: pgfId-4647231]N/A
  
         	[bookmark: pgfId-4647233]mbms_notification_request
  
         	[bookmark: pgfId-4647235]create_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647237]97
  
         	[bookmark: pgfId-4647239]N/A
  
         	[bookmark: pgfId-4647241]mbms_notification_response
  
         	[bookmark: pgfId-4647243]update_bearer_request
  
        
 
         
         	[bookmark: pgfId-4647245]98
  
         	[bookmark: pgfId-4647247]N/A
  
         	[bookmark: pgfId-4647249]mbms_notification_reject_request
  
         	[bookmark: pgfId-4647251]update_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647253]99
  
         	[bookmark: pgfId-4647255]N/A
  
         	[bookmark: pgfId-4647257]mbms_notification_reject_response
  
         	[bookmark: pgfId-4647259]delete_bearer_request
  
        
 
         
         	[bookmark: pgfId-4647261]100
  
         	[bookmark: pgfId-4647263]N/A
  
         	[bookmark: pgfId-4647265]create_mbms_context_request
  
         	[bookmark: pgfId-4647267]delete_bearer_response
  
        
 
         
         	[bookmark: pgfId-4647269]101
  
         	[bookmark: pgfId-4647271]N/A
  
         	[bookmark: pgfId-4647273]create_mbms_context_response
  
         	[bookmark: pgfId-4647275]delete_pdn_request
  
        
 
         
         	[bookmark: pgfId-4647277]102
  
         	[bookmark: pgfId-4647279]N/A
  
         	[bookmark: pgfId-4647281]update_mbms_context_request
  
         	[bookmark: pgfId-4647283]delete_pdn_response
  
        
 
         
         	[bookmark: pgfId-4647285]103
  
         	[bookmark: pgfId-4647287]N/A
  
         	[bookmark: pgfId-4647289]update_mbms_context_response
  
         	[bookmark: pgfId-4647291]N/A
  
        
 
         
         	[bookmark: pgfId-4647293]104
  
         	[bookmark: pgfId-4647295]N/A
  
         	[bookmark: pgfId-4647297]delete_mbms_context_request
  
         	[bookmark: pgfId-4647299]N/A
  
        
 
         
         	[bookmark: pgfId-4647301]105
  
         	[bookmark: pgfId-4647303]N/A
  
         	[bookmark: pgfId-4647305]delete_mbms_context_response
  
         	[bookmark: pgfId-4647307]N/A
  
        
 
         
         	[bookmark: pgfId-4647309]112
  
         	[bookmark: pgfId-4647311]N/A
  
         	[bookmark: pgfId-4647313]mbms_register_request
  
         	[bookmark: pgfId-4647315]N/A
  
        
 
         
         	[bookmark: pgfId-4647317]113
  
         	[bookmark: pgfId-4647319]N/A
  
         	[bookmark: pgfId-4647321]mbms_register_response
  
         	[bookmark: pgfId-4647323]N/A
  
        
 
         
         	[bookmark: pgfId-4647325]114
  
         	[bookmark: pgfId-4647327]N/A
  
         	[bookmark: pgfId-4647329]mbms_deregister_request
  
         	[bookmark: pgfId-4647331]N/A
  
        
 
         
         	[bookmark: pgfId-4647333]115
  
         	[bookmark: pgfId-4647335]N/A
  
         	[bookmark: pgfId-4647337]mbms_deregister_response
  
         	[bookmark: pgfId-4647339]N/A
  
        
 
         
         	[bookmark: pgfId-4647341]116
  
         	[bookmark: pgfId-4647343]N/A
  
         	[bookmark: pgfId-4647345]mbms_session_start_request
  
         	[bookmark: pgfId-4647347]N/A
  
        
 
         
         	[bookmark: pgfId-4647349]117
  
         	[bookmark: pgfId-4647351]N/A
  
         	[bookmark: pgfId-4647353]mbms_session_start_response
  
         	[bookmark: pgfId-4647355]N/A
  
        
 
         
         	[bookmark: pgfId-4647357]118
  
         	[bookmark: pgfId-4647359]N/A
  
         	[bookmark: pgfId-4647361]mbms_session_stop_request
  
         	[bookmark: pgfId-4647363]N/A
  
        
 
         
         	[bookmark: pgfId-4647365]119
  
         	[bookmark: pgfId-4647367]N/A
  
         	[bookmark: pgfId-4647369]mbms_session_stop_response
  
         	[bookmark: pgfId-4647371]N/A
  
        
 
         
         	[bookmark: pgfId-4647373]120
  
         	[bookmark: pgfId-4647375]N/A
  
         	[bookmark: pgfId-4647377]mbms_session_update_request
  
         	[bookmark: pgfId-4647379]N/A
  
        
 
         
         	[bookmark: pgfId-4647381]121
  
         	[bookmark: pgfId-4647383]N/A
  
         	[bookmark: pgfId-4647385]mbms_session_update_response
  
         	[bookmark: pgfId-4647387]N/A
  
        
 
         
         	[bookmark: pgfId-4647389]128
  
         	[bookmark: pgfId-4647391]N/A
  
         	[bookmark: pgfId-4647393]ms_info_change_request
  
         	[bookmark: pgfId-4647395]identification_request
  
        
 
         
         	[bookmark: pgfId-4647397]129
  
         	[bookmark: pgfId-4647399]N/A
  
         	[bookmark: pgfId-4647401]ms_info_change_response
  
         	[bookmark: pgfId-4647403]identification_response
  
        
 
         
         	[bookmark: pgfId-4647405]130
  
         	[bookmark: pgfId-4647407]N/A
  
         	[bookmark: pgfId-4647409]N/A
  
         	[bookmark: pgfId-4647411]sgsn_context_request
  
        
 
         
         	[bookmark: pgfId-4647413]131
  
         	[bookmark: pgfId-4647415]N/A
  
         	[bookmark: pgfId-4647417]N/A
  
         	[bookmark: pgfId-4647419]sgsn_context_response
  
        
 
         
         	[bookmark: pgfId-4647421]132
  
         	[bookmark: pgfId-4647423]N/A
  
         	[bookmark: pgfId-4647425]N/A
  
         	[bookmark: pgfId-4647427]sgsn_context_ack
  
        
 
         
         	[bookmark: pgfId-4647429]133
  
         	[bookmark: pgfId-4647431]N/A
  
         	[bookmark: pgfId-4647433]N/A
  
         	[bookmark: pgfId-4647435]forward_relocation_request
  
        
 
         
         	[bookmark: pgfId-4647437]134
  
         	[bookmark: pgfId-4647439]N/A
  
         	[bookmark: pgfId-4647441]N/A
  
         	[bookmark: pgfId-4647443]forward_relocation_response
  
        
 
         
         	[bookmark: pgfId-4647445]135
  
         	[bookmark: pgfId-4647447]N/A
  
         	[bookmark: pgfId-4647449]N/A
  
         	[bookmark: pgfId-4647451]forward_relocation_complete
  
        
 
         
         	[bookmark: pgfId-4647453]136
  
         	[bookmark: pgfId-4647455]N/A
  
         	[bookmark: pgfId-4647457]N/A
  
         	[bookmark: pgfId-4647459]forward_relocation_complete_ack
  
        
 
         
         	[bookmark: pgfId-4647461]137
  
         	[bookmark: pgfId-4647463]N/A
  
         	[bookmark: pgfId-4647465]N/A
  
         	[bookmark: pgfId-4647467]forward_access
  
        
 
         
         	[bookmark: pgfId-4647469]138
  
         	[bookmark: pgfId-4647471]N/A
  
         	[bookmark: pgfId-4647473]N/A
  
         	[bookmark: pgfId-4647475]forward_access_ack
  
        
 
         
         	[bookmark: pgfId-4647477]139
  
         	[bookmark: pgfId-4647479]N/A
  
         	[bookmark: pgfId-4647481]N/A
  
         	[bookmark: pgfId-4647483]relocation_cancel_request
  
        
 
         
         	[bookmark: pgfId-4647485]140
  
         	[bookmark: pgfId-4647487]N/A
  
         	[bookmark: pgfId-4647489]N/A
  
         	[bookmark: pgfId-4647491]relocation_cancel_response
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     [bookmark: pgfId-4646588]To specify GTP message types:
 
     [bookmark: pgfId-4646589]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4376054]Step 1 On the Create Rule page, select gtp_type in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4376055]The gtp_type keyword appears.
 
     [bookmark: pgfId-4376060]Step 2 Specify a defined decimal value 0 to 255 for the message type, a defined string, or a comma-separated list of either or both in any combination. See the GTP Message Types table for values and strings recognized by the system.
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     [bookmark: pgfId-4375946]A GTP message can include multiple information elements, each of which is identified by both a defined numeric value and a defined string. You can use the gtp_info keyword in combination with the gtp_version keyword to start inspection at the beginning of a specified information element and restrict inspection to the specified information element.
 
     [bookmark: pgfId-4351156]You can specify either the defined decimal value or the defined string for an information element. You can specify a single value or string, and you can use multiple gtp_info keywords in a rule to inspect multiple information elements.
 
     [bookmark: pgfId-4349466]When a message includes multiple information elements of the same type, all are inspected for a match. When information elements occur in an invalid order, only the last instance is inspected.
 
     [bookmark: pgfId-4349880]Note that different GTP versions sometimes use different values for the same information element. For example, the cause information element has a value of 1 in GTPv0 and GTPv1, but a value of 2 in GTPv2.
 
     [bookmark: pgfId-4350347]The gtp_info keyword matches different values depending on the version number in the packet. In the example above, the keyword matches the information element value 1 in a GTPv0 or GTPv1 packet and the value 2 in a GTPv2 packet. The keyword does not match a packet when the information element value in the packet is not a known value for the version specified in the packet.
 
     [bookmark: pgfId-4350853]If you specify an integer for the information element, the keyword matches if the message type in the keyword matches the value in the GTP packet, regardless of the version specified in the packet.
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         	[bookmark: pgfId-4342604]N/A
  
        
 
         
         	[bookmark: pgfId-4342228]191
  
         	[bookmark: pgfId-4342574]N/A
  
         	[bookmark: pgfId-4342232]evolved_allocation1 
  
         	[bookmark: pgfId-4342606]N/A
  
        
 
         
         	[bookmark: pgfId-4342236]192
  
         	[bookmark: pgfId-4342608]N/A
  
         	[bookmark: pgfId-4342240]evolved_allocation2 
  
         	[bookmark: pgfId-4342620]N/A
  
        
 
         
         	[bookmark: pgfId-4342244]193
  
         	[bookmark: pgfId-4342610]N/A
  
         	[bookmark: pgfId-4342248]extended_flags 
  
         	[bookmark: pgfId-4342622]N/A
  
        
 
         
         	[bookmark: pgfId-4342252]194
  
         	[bookmark: pgfId-4342612]N/A
  
         	[bookmark: pgfId-4342256]uci 
  
         	[bookmark: pgfId-4342624]N/A
  
        
 
         
         	[bookmark: pgfId-4342260]195
  
         	[bookmark: pgfId-4342614]N/A
  
         	[bookmark: pgfId-4342264]csg_info 
  
         	[bookmark: pgfId-4342626]N/A
  
        
 
         
         	[bookmark: pgfId-4342268]196
  
         	[bookmark: pgfId-4342616]N/A
  
         	[bookmark: pgfId-4342272]csg_id 
  
         	[bookmark: pgfId-4342628]N/A
  
        
 
         
         	[bookmark: pgfId-4342276]197
  
         	[bookmark: pgfId-4342618]N/A
  
         	[bookmark: pgfId-4342280]cmi 
  
         	[bookmark: pgfId-4342630]N/A
  
        
 
         
         	[bookmark: pgfId-4342284]198
  
         	[bookmark: pgfId-4342632]N/A
  
         	[bookmark: pgfId-4342288]apn_ambr 
  
         	[bookmark: pgfId-4342650]N/A
  
        
 
         
         	[bookmark: pgfId-4342292]199
  
         	[bookmark: pgfId-4342634]N/A
  
         	[bookmark: pgfId-4342296]ue_network 
  
         	[bookmark: pgfId-4342652]N/A
  
        
 
         
         	[bookmark: pgfId-4342300]200
  
         	[bookmark: pgfId-4342636]N/A
  
         	[bookmark: pgfId-4342304]ue_ambr 
  
         	[bookmark: pgfId-4342654]N/A
  
        
 
         
         	[bookmark: pgfId-4342308]201
  
         	[bookmark: pgfId-4342638]N/A
  
         	[bookmark: pgfId-4342312]apn_ambr_nsapi
  
         	[bookmark: pgfId-4342656]N/A
  
        
 
         
         	[bookmark: pgfId-4342316]202
  
         	[bookmark: pgfId-4342640]N/A
  
         	[bookmark: pgfId-4342320]ggsn_backoff_timer
  
         	[bookmark: pgfId-4342658]N/A
  
        
 
         
         	[bookmark: pgfId-4342324]203
  
         	[bookmark: pgfId-4342642]N/A
  
         	[bookmark: pgfId-4342328]signalling_priority_indication
  
         	[bookmark: pgfId-4342660]N/A
  
        
 
         
         	[bookmark: pgfId-4342332]204
  
         	[bookmark: pgfId-4342644]N/A
  
         	[bookmark: pgfId-4342336]signalling_priority_indication_nsapi
  
         	[bookmark: pgfId-4342662]N/A
  
        
 
         
         	[bookmark: pgfId-4342340]205
  
         	[bookmark: pgfId-4342646]N/A
  
         	[bookmark: pgfId-4342344]high_bitrate 
  
         	[bookmark: pgfId-4342664]N/A
  
        
 
         
         	[bookmark: pgfId-4342348]206
  
         	[bookmark: pgfId-4342648]N/A
  
         	[bookmark: pgfId-4342352]max_mbr 
  
         	[bookmark: pgfId-4342666]N/A
  
        
 
         
         	[bookmark: pgfId-4342356]251
  
         	[bookmark: pgfId-4342358]charging_gateway_addr
  
         	[bookmark: pgfId-4342360]charging_gateway_addr
  
         	[bookmark: pgfId-4342668]N/A
  
        
 
         
         	[bookmark: pgfId-4342364]255
  
         	[bookmark: pgfId-4342366]private_extension
  
         	[bookmark: pgfId-4342368]private_extension
  
         	[bookmark: pgfId-4342370]private_extension
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4376148]You can use the following procedure to specify a GTP information element.
 
     [bookmark: pgfId-4378087]To specify a GTP information element:
 
     [bookmark: pgfId-4376149]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4376150]Step 1 On the Create Rule page, select gtp_info in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4376151]The gtp_info keyword appears.
 
     [bookmark: pgfId-4376156]Step 2 Specify a single defined decimal value 0 to 255 for the information element, or a single defined string. See the GTP Information Elements table for values and strings recognized by the system.
 
     [bookmark: pgfId-4776405]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2626610][bookmark: 22710]Modbus Keywords
 
     [bookmark: pgfId-4360220]License: Protection
 
     [bookmark: pgfId-4367516]You can use Modbus keywords to point to the beginning of the Data field in a Modbus request or response, to match against the Modbus Function Code, and to match against a Modbus Unit ID. You can use Modbus keywords alone or in combination with other keywords such as content and byte_jump.
 
     [bookmark: pgfId-4360859]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4360866]modbus_data
 
      	 [bookmark: pgfId-4360873]modbus_func
 
      	 [bookmark: pgfId-4360880]modbus_unit
 
     
 
    
 
     
      [bookmark: pgfId-4362792][bookmark: 24949]modb[bookmark: marker-4399771]us_data
 
     [bookmark: pgfId-4362793]You can use the modbus_data keyword to point to the beginning of the Data field in a Modbus request or response.
 
     [bookmark: pgfId-4363451]To point to the beginning of the Modbus Data field:
 
     [bookmark: pgfId-4363452]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4363453]Step 1 On the Create Rule page, select modbus_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4363454]The modbus_data keyword appears.
 
     [bookmark: pgfId-4363459]The modbus_data keyword has no arguments.
 
     [bookmark: pgfId-4776420]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360420][bookmark: 60489]modb[bookmark: marker-4399776]us_func
 
     [bookmark: pgfId-4360422]You can use the modbus_func keyword to match against the Function Code field in a Modbus application layer request or response header. You can specify either a single defined decimal value or a single defined string for a Modbus function code.
 
     [bookmark: pgfId-4381063]The following table lists the defined values and strings recognized by the system for Modbus function codes.
 
     [bookmark: pgfId-4380199]
 
      
       
        
        [bookmark: pgfId-4380394]Table 36-43 [bookmark: 68960]Modbus Function Codes 
 
        
        
         
         	 
           
           [bookmark: pgfId-4380398]Value 
          
  
         	 
           
           [bookmark: pgfId-4380400]String 
          
  
        
 
         
         	[bookmark: pgfId-4380402]1
  
         	[bookmark: pgfId-4380404]read_coils
  
        
 
         
         	[bookmark: pgfId-4380406]2
  
         	[bookmark: pgfId-4380408]read_discrete_inputs
  
        
 
         
         	[bookmark: pgfId-4380410]3
  
         	[bookmark: pgfId-4380412]read_holding_registers
  
        
 
         
         	[bookmark: pgfId-4380414]4
  
         	[bookmark: pgfId-4380416]read_input_registers
  
        
 
         
         	[bookmark: pgfId-4380418]5
  
         	[bookmark: pgfId-4380420]write_single_coil
  
        
 
         
         	[bookmark: pgfId-4380422]6
  
         	[bookmark: pgfId-4380424]write_single_register
  
        
 
         
         	[bookmark: pgfId-4380426]7
  
         	[bookmark: pgfId-4380428]read_exception_status
  
        
 
         
         	[bookmark: pgfId-4380430]8
  
         	[bookmark: pgfId-4380432]diagnostics
  
        
 
         
         	[bookmark: pgfId-4380434]11
  
         	[bookmark: pgfId-4380436]get_comm_event_counter
  
        
 
         
         	[bookmark: pgfId-4380438]12
  
         	[bookmark: pgfId-4380440]get_comm_event_log
  
        
 
         
         	[bookmark: pgfId-4380442]15
  
         	[bookmark: pgfId-4380444]write_multiple_coils
  
        
 
         
         	[bookmark: pgfId-4380446]16
  
         	[bookmark: pgfId-4380448]write_multiple_registers
  
        
 
         
         	[bookmark: pgfId-4380450]17
  
         	[bookmark: pgfId-4380452]report_slave_id
  
        
 
         
         	[bookmark: pgfId-4380454]20
  
         	[bookmark: pgfId-4380456]read_file_record
  
        
 
         
         	[bookmark: pgfId-4380458]21
  
         	[bookmark: pgfId-4380460]write_file_record
  
        
 
         
         	[bookmark: pgfId-4380462]22
  
         	[bookmark: pgfId-4380464]mask_write_register
  
        
 
         
         	[bookmark: pgfId-4380466]23
  
         	[bookmark: pgfId-4380468]read_write_multiple_registers
  
        
 
         
         	[bookmark: pgfId-4380470]24
  
         	[bookmark: pgfId-4380472]read_fifo_queue
  
        
 
         
         	[bookmark: pgfId-4380474]43
  
         	[bookmark: pgfId-4380476]encapsulated_interface_transport
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4366152]To specify a Modbus function code:
 
     [bookmark: pgfId-4363955]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4363956]Step 1 On the Create Rule page, select modbus_func in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4363957]The modbus_func keyword appears.
 
     [bookmark: pgfId-4380083]Step 2 Specify a single defined decimal value 0 to 255 for the function code, or a single defined string. See the Modbus Function Codes table for values and strings recognized by the system.
 
     [bookmark: pgfId-4776426]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4363862][bookmark: 90813]mod[bookmark: marker-4399784]bus_unit
 
     [bookmark: pgfId-4360452]You can use the modbus_unit keyword to match a single decimal value against the Unit ID field in a Modbus request or response header.
 
     [bookmark: pgfId-4364117]To specify a Modbus unit ID:
 
     [bookmark: pgfId-4364118]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4364119]Step 1 On the Create Rule page, select modbus_unit in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4364120]The modbus_unit keyword appears.
 
     [bookmark: pgfId-4364125]Step 2 Specify a decimal value 0 through 255.
 
     [bookmark: pgfId-4776443]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360327][bookmark: 69807]DNP3 Keywords
 
     [bookmark: pgfId-4438725]License: Protection
 
     [bookmark: pgfId-4367609]You can use DNP3 keywords to point to the beginning of application layer fragments, to match against DNP3 function codes and objects in DNP3 responses and requests, and to match against internal indication flags in DNP3 responses. You can use DNP3 keywords alone or in combination with other keywords such as content and byte_jump.
 
     [bookmark: pgfId-4367610]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4367614]dnp3_data
 
      	 [bookmark: pgfId-4367618]dnp3_func
 
      	 [bookmark: pgfId-4367655]dnp3_ind
 
      	 [bookmark: pgfId-4367622]dnp3_obj
 
     
 
    
 
     
      [bookmark: pgfId-4365658][bookmark: 10691]dnp3_[bookmark: marker-4517645]data
 
     [bookmark: pgfId-4365659]You can use the dnp3_data keyword to point to the beginning of reassembled DNP3 application layer fragments.
 
     [bookmark: pgfId-4367767]The DNP3 preprocessor reassembles link layer frames into application layer fragments. The dnp3_data keyword points to the beginning of each application layer fragment; other rule options can match against the reassembled data within fragments without separating the data and adding checksums every 16 bytes.
 
     [bookmark: pgfId-4379292]To point to the beginning of reassembled DNP3 fragments:
 
     [bookmark: pgfId-4379293]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4379294]Step 1 On the Create Rule page, select modbus_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4379295]The dnp3_data keyword appears.
 
     [bookmark: pgfId-4379300]The dnp3_data keyword has no arguments.
 
     [bookmark: pgfId-4776449]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360920][bookmark: 91334]dnp3_f[bookmark: marker-4517653]unc
 
     [bookmark: pgfId-4360599]You can use the dnp3_func keyword to match against the Function Code field in a DNP3 application layer request or response header. You can specify either a single defined decimal value or a single defined string for a DNP3 function code.
 
     [bookmark: pgfId-4381690]The following table lists the defined values and strings recognized by the system for DNP3 function codes.
 
     [bookmark: pgfId-4381545]
 
      
       
        
        [bookmark: pgfId-4524732]Table 36-44 [bookmark: 71500]DNP3 Function Codes 
 
        
        
         
         	 
           
           [bookmark: pgfId-4524736]Value 
          
  
         	 
           
           [bookmark: pgfId-4524738]String 
          
  
        
 
         
         	[bookmark: pgfId-4524740]0
  
         	[bookmark: pgfId-4524742]confirm
  
        
 
         
         	[bookmark: pgfId-4524744]1
  
         	[bookmark: pgfId-4524746]read
  
        
 
         
         	[bookmark: pgfId-4524748]2
  
         	[bookmark: pgfId-4524750]write
  
        
 
         
         	[bookmark: pgfId-4524752]3
  
         	[bookmark: pgfId-4524754]select
  
        
 
         
         	[bookmark: pgfId-4524756]4
  
         	[bookmark: pgfId-4524758]operate
  
        
 
         
         	[bookmark: pgfId-4524760]5
  
         	[bookmark: pgfId-4524762]direct_operate
  
        
 
         
         	[bookmark: pgfId-4524764]6
  
         	[bookmark: pgfId-4524766]direct_operate_nr
  
        
 
         
         	[bookmark: pgfId-4524768]7
  
         	[bookmark: pgfId-4524770]immed_freeze
  
        
 
         
         	[bookmark: pgfId-4524772]8
  
         	[bookmark: pgfId-4524774]immed_freeze_nr
  
        
 
         
         	[bookmark: pgfId-4524776]9
  
         	[bookmark: pgfId-4524778]freeze_clear
  
        
 
         
         	[bookmark: pgfId-4524780]10
  
         	[bookmark: pgfId-4524782]freeze_clear_nr
  
        
 
         
         	[bookmark: pgfId-4524784]11
  
         	[bookmark: pgfId-4524786]freeze_at_time
  
        
 
         
         	[bookmark: pgfId-4524788]12
  
         	[bookmark: pgfId-4524790]freeze_at_time_nr
  
        
 
         
         	[bookmark: pgfId-4524792]13
  
         	[bookmark: pgfId-4524794]cold_restart
  
        
 
         
         	[bookmark: pgfId-4524796]14
  
         	[bookmark: pgfId-4524798]warm_restart
  
        
 
         
         	[bookmark: pgfId-4524800]15
  
         	[bookmark: pgfId-4524802]initialize_data
  
        
 
         
         	[bookmark: pgfId-4524804]16
  
         	[bookmark: pgfId-4524806]initialize_appl
  
        
 
         
         	[bookmark: pgfId-4524808]17
  
         	[bookmark: pgfId-4524810]start_appl
  
        
 
         
         	[bookmark: pgfId-4524812]18
  
         	[bookmark: pgfId-4524814]stop_appl
  
        
 
         
         	[bookmark: pgfId-4524816]19
  
         	[bookmark: pgfId-4524818]save_config
  
        
 
         
         	[bookmark: pgfId-4524820]20
  
         	[bookmark: pgfId-4524822]enable_unsolicited
  
        
 
         
         	[bookmark: pgfId-4524824]21
  
         	[bookmark: pgfId-4524826]disable_unsolicited
  
        
 
         
         	[bookmark: pgfId-4524828]22
  
         	[bookmark: pgfId-4524830]assign_class
  
        
 
         
         	[bookmark: pgfId-4524832]23
  
         	[bookmark: pgfId-4524834]delay_measure
  
        
 
         
         	[bookmark: pgfId-4524836]24
  
         	[bookmark: pgfId-4524838]record_current_time
  
        
 
         
         	[bookmark: pgfId-4524840]25
  
         	[bookmark: pgfId-4524842]open_file
  
        
 
         
         	[bookmark: pgfId-4524844]26
  
         	[bookmark: pgfId-4524846]close_file
  
        
 
         
         	[bookmark: pgfId-4524848]27
  
         	[bookmark: pgfId-4524850]delete_file
  
        
 
         
         	[bookmark: pgfId-4524852]28
  
         	[bookmark: pgfId-4524854]get_file_info
  
        
 
         
         	[bookmark: pgfId-4524856]29
  
         	[bookmark: pgfId-4524858]authenticate_file
  
        
 
         
         	[bookmark: pgfId-4524860]30
  
         	[bookmark: pgfId-4524862]abort_file
  
        
 
         
         	[bookmark: pgfId-4524864]31
  
         	[bookmark: pgfId-4524866]activate_config
  
        
 
         
         	[bookmark: pgfId-4524868]32
  
         	[bookmark: pgfId-4524870]authenticate_req
  
        
 
         
         	[bookmark: pgfId-4524872]33
  
         	[bookmark: pgfId-4524874]authenticate_err
  
        
 
         
         	[bookmark: pgfId-4524876]129
  
         	[bookmark: pgfId-4524878]response
  
        
 
         
         	[bookmark: pgfId-4524880]130
  
         	[bookmark: pgfId-4524882]unsolicited_response
  
        
 
         
         	[bookmark: pgfId-4524884]131
  
         	[bookmark: pgfId-4524886]authenticate_resp
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4364460]To specify DNP3 function codes:
 
     [bookmark: pgfId-4364509]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4364510]Step 1 On the Create Rule page, select dnp3_func in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4364463]The dnp3_func keyword appears.
 
     [bookmark: pgfId-4380136]Step 2 Specify a single defined decimal value 0 to 255 for the function code, or a single defined string. See the DNP3 Function Codes table for values and strings recognized by the system.
 
     [bookmark: pgfId-4776455]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360644][bookmark: 96427]dnp3_i[bookmark: marker-4517667]nd
 
     [bookmark: pgfId-4360646]You can use the dnp3_ind keyword to match against flags in the Internal Indications field in a DNP3 application layer response header.
 
     [bookmark: pgfId-4364602]You can specify the string for a single known flag or a comma-separated list of flags, as seen in the following example:
 
      
      [bookmark: pgfId-4364603]class_1_events, class_2_events 
     
 
     [bookmark: pgfId-4360648]When you specify multiple flags, the keyword matches against any flag in the list. To detect a combination of flags, use the dnp3_ind keyword multiple times in a rule.
 
     [bookmark: pgfId-4382324]The following list provides the string syntax recognized by the system for defined DNP3 internal indications flags.
 
      
      [bookmark: pgfId-4382610]class_1_events 
     
 
      
      [bookmark: pgfId-4382611]class_2_events 
     
 
      
      [bookmark: pgfId-4382612]class_3_events 
     
 
      
      [bookmark: pgfId-4382613]need_time 
     
 
      
      [bookmark: pgfId-4382614]local_control 
     
 
      
      [bookmark: pgfId-4382615]device_trouble 
     
 
      
      [bookmark: pgfId-4382616]device_restart 
     
 
      
      [bookmark: pgfId-4382617]no_func_code_support 
     
 
      
      [bookmark: pgfId-4382618]object_unknown 
     
 
      
      [bookmark: pgfId-4382619]parameter_error 
     
 
      
      [bookmark: pgfId-4382620]event_buffer_overflow 
     
 
      
      [bookmark: pgfId-4382621]already_executing 
     
 
      
      [bookmark: pgfId-4382622]config_corrupt 
     
 
      
      [bookmark: pgfId-4382623]reserved_2 
     
 
      
      [bookmark: pgfId-4382624]reserved_1 
     
 
     [bookmark: pgfId-4364678]To specify DNP3 internal indications flags:
 
     [bookmark: pgfId-4364679]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4364680]Step 1 On the Create Rule page, select dnp3_ind in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4364681]The dnp3_ind keyword appears.
 
     [bookmark: pgfId-4364686]Step 2 You can specify the string for a single known flag or a comma-separated list of flags.
 
     [bookmark: pgfId-4776477]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4360678][bookmark: 25423]dnp3_[bookmark: marker-4517682]obj
 
     [bookmark: pgfId-4360680]You can use the dnp3_obj keyword to match against DNP3 object headers in a request or response.
 
     [bookmark: pgfId-4360681]DNP3 data is comprised of a series of DNP3 objects of different types such as analog input, binary input, and so on. Each type is identified with a group such as analog input group, binary input group, and so on, each of which can be identified by a decimal value. The objects in each group are further identified by an object variation such as 16-bit integers, 32-bit integers, short floating point, and so on, each of which specifies the data format of the object. Each type of object variation can also be identified by a decimal value.
 
     [bookmark: pgfId-4364831]You identify object headers by specifying the decimal number for the type of object header group and the decimal number for the type of object variation. The combination of the two defines a specific type of DNP3 object.
 
     [bookmark: pgfId-4367560]To specify a DNP3 object:
 
     [bookmark: pgfId-4367561]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4367562]Step 1 On the Create Rule page, select dnp3_obj in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4367563]The dnp3_obj keyword appears.
 
     [bookmark: pgfId-4367568]Step 2 Specify a decimal value 0 through 255 to identify a known object group, and another decimal value 0 through 255 to identify a known object variation type.
 
     [bookmark: pgfId-4776487]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5003276][bookmark: 10861]CIP and ENIP Keywords
 
     [bookmark: pgfId-5003283]License: Protection
 
     [bookmark: pgfId-5003284]You can use the following keywords alone or in combination to create custom intrusion rules that identify attacks against CIP and ENIP traffic detected by the CIP preprocessor. For configurable keywords, specify a single integer within the allowed range. See Configuring the CIP Preprocessor for more information.
 
     [bookmark: pgfId-5003352]
 
      
       
        
        [bookmark: pgfId-5003290]Table 36-45 CIP and ENIP Keywords
 
        
        
         
         	 
           
           [bookmark: pgfId-5003294]Keyword 
          
  
         	 
           
           [bookmark: pgfId-5003296]Range 
          
  
        
 
         
         	[bookmark: pgfId-5003299]cip_attribute[bookmark: marker-5003298]
  
         	[bookmark: pgfId-5003301]0 - 65535
  
        
 
         
         	[bookmark: pgfId-5003304]cip_class[bookmark: marker-5003303]
  
         	[bookmark: pgfId-5003306]0 - 65535
  
        
 
         
         	[bookmark: pgfId-5003309]cip_conn_path_class[bookmark: marker-5003308]
  
         	[bookmark: pgfId-5003311]0 - 65535
  
        
 
         
         	[bookmark: pgfId-5003314]cip_instance[bookmark: marker-5003313]
  
         	[bookmark: pgfId-5003316]0 - 4284927295
  
        
 
         
         	[bookmark: pgfId-5003319]cip_req[bookmark: marker-5003318]
  
         	[bookmark: pgfId-5003321]N/A
  
        
 
         
         	[bookmark: pgfId-5003324]cip_rsp[bookmark: marker-5003323]
  
         	[bookmark: pgfId-5003326]N/A
  
        
 
         
         	[bookmark: pgfId-5003329]cip_service[bookmark: marker-5003328]
  
         	[bookmark: pgfId-5003331]0 - 127
  
        
 
         
         	[bookmark: pgfId-5003334]cip_status[bookmark: marker-5003333]
  
         	[bookmark: pgfId-5003336]0 - 255
  
        
 
         
         	[bookmark: pgfId-5003339]enip_command[bookmark: marker-5003338]
  
         	[bookmark: pgfId-5003341]0 - 65535
  
        
 
         
         	[bookmark: pgfId-5003344]enip_req[bookmark: marker-5003343]
  
         	[bookmark: pgfId-5003346]N/A
  
        
 
         
         	[bookmark: pgfId-5003349]enip_rsp[bookmark: marker-5003348]
  
         	[bookmark: pgfId-5003351]N/A
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-4360200][bookmark: 29195]Inspecting Packet Characteristics
 
     [bookmark: pgfId-4238908]License: Protection
 
     [bookmark: pgfId-1072591]You can write rules that only generate events against packets with specific packet characteristics. The FireSIGHT System provides the following keywords to evaluate packet characteristics:
 
      
      	 [bookmark: pgfId-3926389]dsize
 
      	 [bookmark: pgfId-4002958]isdataat
 
      	 [bookmark: pgfId-3926397]sameip
 
      	 [bookmark: pgfId-1232966]fragoffset
 
      	 [bookmark: pgfId-2771034]cvs
 
     
 
    
 
     
      [bookmark: pgfId-1494941][bookmark: 30570]dsize 
 
     [bookmark: pgfId-4238921]License: Protection
 
     [bookmark: pgfId-1116301]The [bookmark: marker-1161992]dsize keyword tests the packet payload size. With it, you can use the greater than and less than operators (< and >) to specify a range of values. You can use the following syntax to specify ranges:
 
      
      [bookmark: pgfId-1072610]>number_of_bytes 
     
 
      
      [bookmark: pgfId-1072614]<number_of_bytes 
     
 
      
      [bookmark: pgfId-1072615]number_of_bytes<>number_of_bytes 
     
 
     [bookmark: pgfId-1072616]For example, to indicate a packet size greater than 400 bytes, use >400 as the dtype value. To indicate a packet size of less than 500 bytes, use <500. To specify that the rule trigger against any packet between 400 and 500 bytes inclusive, use 400<>500.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1079544] 
      Caution The 
      dsize keyword tests packets before they are decoded by any preprocessors. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-4002965][bookmark: 19073]isda[bookmark: marker-4002964]taat
 
     [bookmark: pgfId-4238942]License: Protection
 
     [bookmark: pgfId-4002970]The isdataat keyword instructs the rules engine to verify that data resides at a specific location in the payload. 
 
      
       
        
        [bookmark: pgfId-4002981]Table 36-46 [bookmark: 86292]isdataat Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4002987]Argument 
          
  
         	 
           
           [bookmark: pgfId-4002989]Type 
          
  
         	 
           
           [bookmark: pgfId-4002991]Description 
          
  
        
 
         
         	[bookmark: pgfId-4002993]Offset
  
         	[bookmark: pgfId-4002995]Required
  
         	[bookmark: pgfId-4002997]The specific location in the payload. For example, to test that data appears at byte 50 in the packet payload, you would specify 50 as the offset value. A ! modifier negates the results of the isdataat test; it alerts if a certain amount of data is not present within the payload.
 [bookmark: pgfId-4002998]You can also use an existing byte_extract variable to specify the value for this argument. See Reading Packet Data into Keyword Arguments for more information.
  
        
 
         
         	[bookmark: pgfId-4003003]Relative
  
         	[bookmark: pgfId-4003005]Optional
  
         	[bookmark: pgfId-4003007]Makes the location relative to the last successful content match. If you specify a relative location, note that the counter starts at byte 0, so calculate the location by subtracting 1 from the number of bytes you want to move forward from the last successful content match. For example, to specify that the data must appear at the ninth byte after the last successful content match, you would specify a relative offset of 8.
  
        
 
         
         	[bookmark: pgfId-4093348]Raw Data
  
         	[bookmark: pgfId-4093350]Optional
  
         	[bookmark: pgfId-4093379]Specifies that the data is located in the original packet payload before decoding or application layer normalization by any FireSIGHT System preprocessor. You can use this argument with Relative if the previous content match was in the raw packet data.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003009]For example, in a rule searching for the content foo, if the value for isdataat is specified as the following:
 
      
      	 [bookmark: pgfId-4003010]Offset = !10
 
      	 [bookmark: pgfId-4003011]Relative = enabled
 
     
 
     [bookmark: pgfId-4003015]The system alerts if the rules engine does not detect 10 bytes after foo before the payload ends.
 
     [bookmark: pgfId-4003016]To use isdataat:
 
     [bookmark: pgfId-4418358]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4003017]Step 1 On the Create Rule page, select isdataat in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4003018]The isdataat section appears.
 
     [bookmark: pgfId-4776507]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1495174][bookmark: 60894]sameip 
 
     [bookmark: pgfId-4238963]License: Protection
 
     [bookmark: pgfId-1158460]The [bookmark: marker-1161993]sameip keyword tests that a packet’s source and destination IP addresses are the same. It does not take an argument. 
 
    
 
     
      [bookmark: pgfId-4093339][bookmark: 36955]frag[bookmark: marker-4093338]offset
 
     [bookmark: pgfId-4238980]License: Protection
 
     [bookmark: pgfId-4093344]The fragoffset keyword tests the offset of a fragmented packet. This is useful because some exploits (such as WinNuke denial-of-service attacks) use hand-generated packet fragments that have specific offsets.
 
     [bookmark: pgfId-2055161]For example, to test whether the offset of a fragmented packet is 31337 bytes, specify 31337 as the fragoffset value.
 
     [bookmark: pgfId-2054987]You can use the following operators when specifying arguments for the fragoffset keyword.
 
     [bookmark: pgfId-2054988]
 
      
       
        
        [bookmark: pgfId-2054991]Table 36-47 fragoffset Keyword Argument Operators 
 
        
        
         
         	 
           
           [bookmark: pgfId-2054995]Operator 
          
  
         	 
           
           [bookmark: pgfId-2054997]Description 
          
  
        
 
         
         	[bookmark: pgfId-2054999]!
  
         	[bookmark: pgfId-2055001]not
  
        
 
         
         	[bookmark: pgfId-2055003]>
  
         	[bookmark: pgfId-2055005]greater than
  
        
 
         
         	[bookmark: pgfId-2055007]<
  
         	[bookmark: pgfId-2055009]less than
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2871094]Note that you cannot use the not (!) operator in combination with < or >.
 
    
 
     
      [bookmark: pgfId-4021634][bookmark: marker-2771035][bookmark: 86688]cvs
 
     [bookmark: pgfId-4238997]License: Protection
 
     [bookmark: pgfId-2867768]The cvs keyword tests Concurrent Versions System (CVS) traffic for malformed CVS entries. An attacker can use a malformed entry to force a heap overflow and execute malicious code on the CVS server. This keyword can be used to identify attacks against two known CVS vulnerabilities: CVE-2004-0396 (CVS 1.11.x up to 1.11.15, and 1.12.x up to 1.12.7) and CVS-2004-0414 (CVS 1.12.x through 1.12.8, and 1.11.x through 1.11.16). The cvs keyword checks for a well-formed entry, and generates alerts when a malformed entry is detected.
 
     [bookmark: pgfId-2867769]Your rule should include the ports where CVS runs. In addition, any ports where traffic may occur should be added to the list of ports for stream reassembly in your TCP policies so state can be maintained for CVS sessions. The TCP ports 2401 (pserver) and 514 (rsh) are included in the list of client ports where stream reassembly occurs. However, note that if your server runs as an xinetd server (i.e., pserver), it can run on any TCP port. Add any non-standard ports to the stream reassembly Client Ports list. For more information, see Selecting Stream Reassembly Options. 
 
     [bookmark: pgfId-2867776]To detect malformed CVS entries:
 
     [bookmark: pgfId-4241064]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-2867778]Step 1 Add the cvs option to a rule and type invalid-entry as the keyword argument. 
 
     [bookmark: pgfId-4776518]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4003028][bookmark: 78615]Reading Packet Data into Keyword Arguments
 
     [bookmark: pgfId-4239010]License: Protection
 
     [bookmark: pgfId-4003033]You can use the [bookmark: marker-4120571]byte_extract keyword to read a specified number of bytes from a packet into a variable. You can then use the variable later in the same rule as the value for specific arguments in certain other detection keywords.
 
     [bookmark: pgfId-4017786]This is useful, for example, for extracting data size from packets where a specific segment of bytes describes the number of bytes included in data within the packet. For example, a specific segment of bytes might say that subsequent data is comprised of four bytes; you can extract the data size of four bytes to use as your variable value.
 
     [bookmark: pgfId-4017816]You can use byte_extract to create up to two separate variables in a rule concurrently. You can redefine a byte_extract variable any number of times; entering a new byte_extract keyword with the same variable name and a different variable definition overwrites the previous definition of that variable.
 
      
       
        
        [bookmark: pgfId-4003045]Table 36-48 [bookmark: 51691]Required byte_extract Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003049]Argument 
          
  
         	 
           
           [bookmark: pgfId-4003051]Description 
          
  
        
 
         
         	[bookmark: pgfId-4003053]Bytes to Extract
  
         	[bookmark: pgfId-4003055]The number of bytes to extract from the packet. You can specify 1, 2, 3, or 4 bytes.
  
        
 
         
         	[bookmark: pgfId-4003057]Offset
  
         	[bookmark: pgfId-4003059]The number of bytes into the payload to begin extracting data. You can specify -65534 to 65535 bytes. The offset counter starts at byte 0, so calculate the offset value by subtracting 1 from the number of bytes you want to count forward. For example, specify 7 to count forward 8 bytes. The rules engine counts forward from the beginning of the packet payload or, if you also specify Relative, after the last successful content match. Note that you can specify negative numbers only when you also specify Relative; see the Additional Optional byte_extract Arguments table for more information.
  
        
 
         
         	[bookmark: pgfId-4003064]Variable Name
  
         	[bookmark: pgfId-4003066]The variable name to use in arguments for other detection keywords. You can specify an alphanumeric string that must begin with a letter.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003068]To further define how the system locates the data to extract, you can use the arguments described in the following table.
 
     [bookmark: pgfId-4003103]
 
      
       
        
        [bookmark: pgfId-4003078]Table 36-49 [bookmark: 38048]Additional Optional byte_extract Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003082]Argument 
          
  
         	 
           
           [bookmark: pgfId-4003084]Description 
          
  
        
 
         
         	[bookmark: pgfId-4003086]Multiplier
  
         	[bookmark: pgfId-4003088]A multiplier for the value extracted from the packet. You can specify 0 to 65535. If you do not specify a multiplier, the default value is 1.
  
        
 
         
         	[bookmark: pgfId-4003090]Align
  
         	[bookmark: pgfId-4003092]Rounds the extracted value to the nearest 2-byte or 4-byte boundary. When you also select Multiplier, the system applies the multiplier before the alignment.
  
        
 
         
         	[bookmark: pgfId-4003097]Relative
  
         	[bookmark: pgfId-4003099]Makes Offset relative to the end of the last successful content match instead of the beginning of the payload. See the Required byte_extract Arguments table for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003104]You can specify only one of DCE/RPC, Endian, or Number Type.
 
      
       
        
        [bookmark: pgfId-4003114]Table 36-50 [bookmark: 18197]Endianness byte_extract Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003118]Argument 
          
  
         	 
           
           [bookmark: pgfId-4003120]Description 
          
  
        
 
         
         	[bookmark: pgfId-4003122]Big Endian
  
         	[bookmark: pgfId-4003124]Processes data in big endian byte order, which is the default network byte order.
  
        
 
         
         	[bookmark: pgfId-4003126]Little Endian
  
         	[bookmark: pgfId-4003128]Processes data in little endian byte order.
  
        
 
         
         	[bookmark: pgfId-4003130]DCE/RPC
  
         	[bookmark: pgfId-4003132]Specifies a byte_extract keyword for traffic processed by the DCE/RPC preprocessor. See Decoding DCE/RPC Traffic for more information.
 [bookmark: pgfId-4003136]The DCE/RPC preprocessor determines big endian or little endian byte order, and the Number Type and Endian arguments do not apply.
 [bookmark: pgfId-4003137]When you enable this argument, you can also use byte_extract in conjunction with other specific DCE/RPC keywords. See DCE/RPC Keywords for more information.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003146]You can specify a number type to read data as an ASCII string. To define how the system views string data in a packet, you can select one of the arguments in the following table.
 
     [bookmark: pgfId-4003175]
 
      
       
        
        [bookmark: pgfId-4003156]Table 36-51 [bookmark: 99171]Number Type byte_extract arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003160]Argument 
          
  
         	 
           
           [bookmark: pgfId-4003162]Description 
          
  
        
 
         
         	[bookmark: pgfId-4003164]Hexadecimal String
  
         	[bookmark: pgfId-4003166]Reads extracted string data in hexadecimal format.
  
        
 
         
         	[bookmark: pgfId-4003168]Decimal String
  
         	[bookmark: pgfId-4003170]Reads extracted string data in decimal format.
  
        
 
         
         	[bookmark: pgfId-4003172]Octal String
  
         	[bookmark: pgfId-4003174]Reads extracted string data in octal format.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003176]For example, if the value for byte_extract is specified as the following:
 
      
      	 [bookmark: pgfId-4003177]Bytes to Extract = 4
 
      	 [bookmark: pgfId-4003178]Variable Name = var
 
      	 [bookmark: pgfId-4003179]Offset = 8
 
      	 [bookmark: pgfId-4003180]Relative = enabled
 
     
 
     [bookmark: pgfId-4003181]the rules engine reads the number described in the four bytes that appear 9 bytes away from (relative to) the last successful content match into a variable named var, which you can specify later in the rule as the value for certain keyword arguments.
 
     [bookmark: pgfId-4003185]The following table lists the keyword arguments where you can specify a variable defined in the byte_extract keyword.
 
     [bookmark: pgfId-4003231]
 
      
       
        
        [bookmark: pgfId-4003192]Table 36-52 [bookmark: 47245]Arguments Accepting a byte_extract Variable 
 
        
        
         
         	 
           
           [bookmark: pgfId-4003196]Keyword 
          
  
         	 
           
           [bookmark: pgfId-4003198]Argument 
          
  
         	 
           
           [bookmark: pgfId-4915305]For more information, see... 
          
  
        
 
         
         	[bookmark: pgfId-4003200]content
  
         	[bookmark: pgfId-4003202]Depth, Offset, Distance, Within
  
         	[bookmark: pgfId-4915307]Constraining Content Matches
  
        
 
         
         	[bookmark: pgfId-4003208]byte_jump
  
         	[bookmark: pgfId-4003210]Offset
  
         	[bookmark: pgfId-4915309]byte_jump
  
        
 
         
         	[bookmark: pgfId-4003216]byte_test
  
         	[bookmark: pgfId-4915402]Offset, Value
  
         	[bookmark: pgfId-4915311]byte_test
  
        
 
         
         	[bookmark: pgfId-4003224]isdataat
  
         	[bookmark: pgfId-4003226]Offset
  
         	[bookmark: pgfId-4915313]isdataat
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003232]To use byte_extract:
 
     [bookmark: pgfId-4241078]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4003234]Step 1 On the Create Rule page, select t byte_extract in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4003235]The byte_extract section appears beneath the last keyword you selected.
 
     [bookmark: pgfId-4776594]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4003246][bookmark: 52622]Initiating Ac[bookmark: marker-4003245]tive Responses with Rule Keywords
 
     [bookmark: pgfId-4239023]License: Protection
 
     [bookmark: pgfId-4003254]The system can initiate active responses to close TCP connections in response to triggered TCP rules or UDP sessions in response to triggered UDP rules. Two keywords provide you with separate approaches to initiating active responses. When a packet triggers a rule containing either of the keywords, the system initiates a single active response. You can also use the config response command to configure the active response interface to use and the number of TCP resets to attempt in a passive deployment.
 
     [bookmark: pgfId-4003263]Active responses are most effective in inline deployments because resets are more likely to arrive in time to affect the connection or session. For example, in response to the react keyword in an inline deployment, the system inserts a TCP reset (RST) packet directly into the traffic for each end of the connection, which normally should close the connection.
 
     [bookmark: pgfId-4003267]Active responses are not intended to take the place of a firewall for a number of reasons, including that the system cannot insert packets in passive deployments and an attacker may have chosen to ignore or circumvent active responses.
 
     [bookmark: pgfId-4003274]Because active responses can be routed back, the system does not allow TCP resets to initiate TCP resets; this prevents an unending sequence of active responses. The system also does not allow ICMP unreachable packets to initiate ICMP unreachable packets in keeping with standard practice.
 
     [bookmark: pgfId-4003278]You can configure the TCP stream preprocessor to detect additional traffic on a connection or session after an intrusion rule has triggered an active response. When the preprocessor detects additional traffic, it sends additional active responses up to a specified maximum to both ends of the connection or session. See Initiating Active Responses with Intrusion Drop Rules for more information.
 
     [bookmark: pgfId-4003286]See the following sections for information specific to the keywords you can use to initiate active responses:
 
      
      	 [bookmark: pgfId-4003290]Initiating Active Responses by Type and Direction
 
      	 [bookmark: pgfId-4003294]Sending an HTML Page Before a TCP Reset
 
      	 [bookmark: pgfId-4003298]Setting the Active Response Reset Attempts and Interface
 
     
 
    
 
     
      [bookmark: pgfId-4003301][bookmark: 94979]Initiating Active Res[bookmark: marker-4003300]ponses by Type and Direction
 
     [bookmark: pgfId-4239040]License: Protection
 
     [bookmark: pgfId-4003306]You can use the resp keyword to actively respond to TCP connections or UDP sessions, depending on whether you specify the TCP or UDP protocol in the rule header. See Specifying Protocols for more information.
 
     [bookmark: pgfId-4003315]Keyword arguments allow you to specify the packet direction and whether to use TCP reset (RST) packets or ICMP unreachable packets as active responses.
 
     [bookmark: pgfId-4003316]You can use any of the TCP reset or ICMP unreachable arguments to close TCP connections. You should use only ICMP unreachable arguments to close UDP sessions.
 
     [bookmark: pgfId-4003317]Different TCP reset arguments also allow you to target active responses to the packet source, destination, or both. All ICMP unreachable arguments target the packet source and allow you to specify whether to use an ICMP network, host, or port unreachable packet, or all three.
 
      
       
        
        [bookmark: pgfId-4915521]Table 36-53 [bookmark: 35001]resp Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4915525]Argument 
          
  
         	 
           
           [bookmark: pgfId-4915527]Description 
          
  
        
 
         
         	[bookmark: pgfId-4915530][bookmark: marker-4915529]reset_source
  
         	[bookmark: pgfId-4915532]Directs a TCP reset packet to the endpoint that sent the packet that triggered the rule. Alternatively, you can specify rst_snd, which is supported for backward compatibility.
  
        
 
         
         	[bookmark: pgfId-4915535][bookmark: marker-4915534]reset_dest
  
         	[bookmark: pgfId-4915537]Directs a TCP reset packet to the intended destination endpoint of the packet that triggered the rule. Alternatively, you can specify rst_rcv, which is supported for backward compatibility.
  
        
 
         
         	[bookmark: pgfId-4915540][bookmark: marker-4915539]reset_both
  
         	[bookmark: pgfId-4915542]Directs a TCP reset packet to both the sending and receiving endpoints. Alternatively, you can specify rst_all, which is supported for backward compatibility.
  
        
 
         
         	[bookmark: pgfId-4915545][bookmark: marker-4915544]icmp_net
  
         	[bookmark: pgfId-4915547]Directs an ICMP network unreachable message to the sender.
  
        
 
         
         	[bookmark: pgfId-4915550][bookmark: marker-4915549]icmp_host
  
         	[bookmark: pgfId-4915552]Directs an ICMP host unreachable message to the sender.
  
        
 
         
         	[bookmark: pgfId-4915555][bookmark: marker-4915554]icmp_port
  
         	[bookmark: pgfId-4915557]Directs an ICMP port unreachable message to the sender. This argument is used to terminate UDP traffic.
  
        
 
         
         	[bookmark: pgfId-4915560][bookmark: marker-4915559]icmp_all
  
         	[bookmark: pgfId-4915562]Directs the following ICMP messages to the sender:
 
           
           	 [bookmark: pgfId-4915563]network unreachable
 
           	 [bookmark: pgfId-4915564]host unreachable
 
           	 [bookmark: pgfId-4915565]port unreachable
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4003404]For example, to configure a rule to reset both sides of a connection when a rule is triggered, use reset_both as the value for the resp keyword.
 
     [bookmark: pgfId-4003405]You can use a comma-separated list to specify multiple arguments as follows:
 
      
      [bookmark: pgfId-4003406]argument,argument,argument 
     
 
     [bookmark: pgfId-4003410]See Setting the Active Response Reset Attempts and Interface for information on using the config response command to configure the active response interface to use and the number of TCP resets to attempt in a passive deployment.
 
     [bookmark: pgfId-4003411]To specify active responses:
 
     [bookmark: pgfId-4241096]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4003413]Step 1 On the Create Rule page, select resp in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4003414]The resp keyword appears.
 
     [bookmark: pgfId-4003426]Step 2 Specify any of the arguments in the resp Arguments table in the resp field; use a comma-separated list to specify multiple arguments.
 
     [bookmark: pgfId-4776600]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4003429][bookmark: 65958]Sending an HTML Page Before a TCP Rese[bookmark: marker-4003428]t
 
     [bookmark: pgfId-4239054]License: Protection
 
     [bookmark: pgfId-4003434]You can use the react keyword to send a default HTML page to the TCP connection client when a packet triggers the rule; after sending the HTML page, the system uses TCP reset packets to initiate active responses to both ends of the connection. The react keyword does not trigger active responses for UDP traffic.
 
     [bookmark: pgfId-4003443]Optionally, you can specify the following argument:
 
      
      [bookmark: pgfId-4003445]msg[bookmark: marker-4003444] 
     
 
     [bookmark: pgfId-4003446]When a packet triggers a react rule that uses the msg argument, the HTML page includes the rule event message. See Understanding Rule Anatomy for a description of the event message field.
 
     [bookmark: pgfId-4003450]If you do not specify the msg argument, the HTML page includes the following message:
 
      
      [bookmark: pgfId-4003451]You are attempting to access a forbidden site.
Consult your system administrator for details. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4003452]Note Because active responses can be routed back, ensure that the HTML response page does not trigger a react rule; this could result in an unending sequence of active responses. Cisco recommends that you test react rules extensively before activating them in a production environment.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4003459]See Setting the Active Response Reset Attempts and Interface for information on using the config response command to configure the active response interface to use and the number of TCP resets to attempt in a passive deployment.
 
     [bookmark: pgfId-4003460]To send an HTML page before initiating an active responses:
 
     [bookmark: pgfId-4241110]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4003462]Step 1 On the Create Rule page, select react in the drop-down list and click Add Option.
 
     [bookmark: pgfId-4003463]The react keyword appears.
 
     [bookmark: pgfId-4003472]Step 2 You have two choices:
 
      
       
       	 [bookmark: pgfId-4003473]To send an HTML page that includes the event message configured for the rule to the client before closing a connection, type  msg in the  react field.
 
       	 [bookmark: pgfId-3816180]To send an HTML page that includes the following default message to the client before closing a connection, leave the  react field blank:
 
      
 
     
 
      
      [bookmark: pgfId-4003479]You are attempting to access a forbidden site.
Consult your system administrator for details 
     
 
     [bookmark: pgfId-4776622]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4003483][bookmark: 13811]Setting the Ac[bookmark: marker-4003481]tive Response Reset Attempts and Interface
 
     [bookmark: pgfId-4239068]License: Protection
 
     [bookmark: pgfId-4054288]You can use the config response command to further configure the behavior of TCP resets initiated by resp and react rules. This command also affects the behavior of active responses initiated by drop rules; see Initiating Active Responses with Intrusion Drop Rules for more information.
 
     [bookmark: pgfId-4003493]You use the config response command by inserting it on a separate line in the USER_CONF advanced variable. See Understanding Advanced Variables for information on using a USER_CONF variable.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-4003503] 
      Caution Do 
      not use the 
      USER_CONF advanced variable to configure an intrusion policy feature unless you are instructed to do so in the feature description or by Support. Conflicting or duplicate configurations will halt the system. 
       
       
 
      
 
     
 
     [bookmark: pgfId-4003510]To specify active response reset attempts, the active response interface, or both:
 
     [bookmark: pgfId-4241123]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4003512]Step 1 Depending on whether you want to specify only the number of active responses, only the active response interface, or both, insert a form of the config response command on a separate line in the USER_CONF advanced variable. You have the following choices:
 
      
       
       	 [bookmark: pgfId-4003513]To specify only the number of active response attempts, insert the command:
  config response: attempts   att 
 
      
 
     
 
     [bookmark: pgfId-4549044]For example: config response: attempts 10
 
      
       
       	 [bookmark: pgfId-4549045]To specify only the active response interface, insert the command:
  config response: device   dev 
 
      
 
     
 
     [bookmark: pgfId-4003516]For example: config response: device eth0
 
      
       
       	 [bookmark: pgfId-4003517]To specify both the number of active response attempts and the active response interface, insert the command:
  config response: attempts   att,  device   dev 
 
      
 
     
 
     [bookmark: pgfId-4003518]For example: config response: attempts 10, device eth0
 
     [bookmark: pgfId-4003519]where:
 
     [bookmark: pgfId-4003520]att is the number 1 to 20 of attempts to land each TCP reset packet within the current connection window so the receiving host accepts the packet. This sequence strafing is useful only in passive deployments; in inline deployments, the system inserts reset packets directly into the stream in place of triggering packets. the system sends only 1 ICMP reachable active response.
 
     [bookmark: pgfId-4003530]dev is an alternate interface where you want the system to send active responses in a passive deployment or insert active responses in an inline deployment.
 
     [bookmark: pgfId-4776636]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3845717][bookmark: 75844]Filtering Events
 
     [bookmark: pgfId-4239081]License: Protection
 
     [bookmark: pgfId-3455604]You can use the [bookmark: marker-3455603]detection_filter keyword to prevent a rule from generating events unless a specified number of packets trigger the rule within a specified time. This can stop the rule from prematurely generating events. For example, two or three failed login attempts within a few seconds could be expected behavior, but a large number of attempts within the same time could indicate a brute force attack.
 
     [bookmark: pgfId-4108364]The detection_filter keyword requires arguments that define whether the system tracks the source or destination IP address, the number of times the detection criteria must be met before triggering an event, and how long to continue the count.
 
     [bookmark: pgfId-4108365]Use the following syntax to delay the triggering of events:
 
      
      [bookmark: pgfId-4108366]track by_src/by_dst, count count, seconds number_of_seconds 
     
 
     [bookmark: pgfId-4108367]The track argument specifies whether to use the packet’s source or destination IP address when counting the number of packets that meet the rule’s detection criteria. Select from the argument values described in the following table to specify how the system tracks event instances. 
 
     [bookmark: pgfId-4108392]
 
      
       
        
        [bookmark: pgfId-4108377]Table 36-54 [bookmark: 44064]detection_filter Track Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4108381]Argument 
          
  
         	 
           
           [bookmark: pgfId-4108383]Description 
          
  
        
 
         
         	[bookmark: pgfId-4108385]by_src
  
         	[bookmark: pgfId-4108387]Detection criteria count by source IP address.
  
        
 
         
         	[bookmark: pgfId-4108389]by_dst
  
         	[bookmark: pgfId-4108391]Detection criteria count by destination IP address.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4108393]The count argument specifies the number of packets that must trigger the rule for the specified IP address within the specified time before the rule generates an event.
 
     [bookmark: pgfId-4108394]The seconds argument specifies the number of seconds within which the specified number of packets must trigger the rule before the rule generates an event.
 
     [bookmark: pgfId-4108395]Consider the case of a rule that searches packets for the content foo and uses the detection_filter keyword with the following arguments:
 
      
      [bookmark: pgfId-3455640]track by_src, count 10, seconds 20 
     
 
     [bookmark: pgfId-3455641]In the example, the rule will not generate an event until it has detected foo in 10 packets within 20 seconds from a given source IP address. If the system detects only 7 packets containing foo within the first 20 seconds, no event is generated. However, if foo occurs 40 times in the first 20 seconds, the rule generates 30 events and the count begins again when 20 seconds have elapsed.
 
     [bookmark: pgfId-3455645]Comparing the threshold and detection_filter Keywords
 
     [bookmark: pgfId-3455647]The detection_filter keyword replaces the deprecated threshold[bookmark: marker-3455646] keyword. The threshold keyword is still supported for backward compatibility and operates the same as thresholds that you set within an intrusion policy.
 
     [bookmark: pgfId-3455648]The detection_filter keyword is a detection feature that is applied before a packet triggers a rule. The rule does not generate an event for triggering packets detected before the specified packet count and, in an inline deployment, does not drop those packets if the rule is set to drop packets. Conversely, the rule does generate events for packets that trigger the rule and occur after the specified packet count and, in an inline deployment, drops those packets if the rule is set to drop packets.
 
     [bookmark: pgfId-3455649]Thresholding is an event notification feature that does not result in a detection action. It is applied after a packet triggers an event. In an inline deployment, a rule that is set to drop packets drops all packets that trigger the rule, independent of the rule threshold.
 
     [bookmark: pgfId-4194865]Note that you can use the detection_filter keyword in any combination with the intrusion event thresholding, intrusion event suppression, and rate-based attack prevention features in an intrusion policy. Note also that policy validation fails if you enable an imported local rule that uses the deprecated threshold keyword in combination with the intrusion event thresholding feature in an intrusion policy. See Configuring Event Thresholding, Configuring Suppression Per Intrusion Policy, Setting a Dynamic Rule State, and Importing Local Rule Files for more information.
 
    
 
     
      [bookmark: pgfId-1100620][bookmark: 93013]Evaluating Post-Attack Traffic
 
     [bookmark: pgfId-4239098]License: Protection
 
     [bookmark: pgfId-1116822]Use the [bookmark: marker-1162033]tag keyword to tell the system to log additional traffic for the host or session. Use the following syntax when specifying the type and amount of traffic you want to capture using the tag keyword:
 
      
      [bookmark: pgfId-1160681]tagging_type, count, metric, optional_direction 
     
 
     [bookmark: pgfId-2544019]The next three tables describe the other available arguments.
 
      
       
        
        [bookmark: pgfId-1447578]Table 36-55 [bookmark: 45475]Tag Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1161053]Argument 
          
  
         	 
           
           [bookmark: pgfId-1161055]Description 
          
  
        
 
         
         	[bookmark: pgfId-1161057]session
  
         	[bookmark: pgfId-1161059]Logs packets in the session that triggered the rule.
  
        
 
         
         	[bookmark: pgfId-1161061]host
  
         	[bookmark: pgfId-1161063]Logs packets from the host that sent the packet that triggered the rule. You can add a directional modifier to log only the traffic coming from the host (src) or going to the host (dst).
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4883958]To indicate how much traffic you want to log, use the following argument:
 
     [bookmark: pgfId-4883977]
 
      
       
        
        [bookmark: pgfId-4883965]Table 36-56 [bookmark: 80039]Count Argument 
 
        
        
         
         	 
           
           [bookmark: pgfId-4883969]Argument 
          
  
         	 
           
           [bookmark: pgfId-4883971]Description 
          
  
        
 
         
         	[bookmark: pgfId-4883973]count
  
         	[bookmark: pgfId-4883975]The number of packets or seconds you want to log after the rule triggers. 
 [bookmark: pgfId-4883976]This unit of measure is specified with the metric argument, which follows the count argument.
  
        
 
        
      
 
     
 
      
       
        
        [bookmark: pgfId-1924041]Table 36-57 [bookmark: 13997]Logging Metrics Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-1924045]Argument 
          
  
         	 
           
           [bookmark: pgfId-1924047]Description 
          
  
        
 
         
         	[bookmark: pgfId-1924049]packets
  
         	[bookmark: pgfId-1924051]Logs the number of packets specified by the count after the rule triggers.
  
        
 
         
         	[bookmark: pgfId-1924053]seconds
  
         	[bookmark: pgfId-1924055]Logs traffic for the number of seconds specified by the count after the rule triggers.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1924057]For example, when a rule with the following tag keyword value triggers:
 
      
      [bookmark: pgfId-1924058]host, 30, seconds, dst 
     
 
     [bookmark: pgfId-1161395]all packets that are transmitted from the client to the host for the next 30 seconds are logged.
 
    
 
     
      [bookmark: pgfId-1493319][bookmark: 94823]Detecting Attacks That Span Multiple Packets
 
     [bookmark: pgfId-4239115]License: Protection
 
     [bookmark: pgfId-3720025]Use the flowbits[bookmark: marker-3720024] keyword to assign state names to sessions. By analyzing subsequent packets in a session according to the previously named state, the system can detect and alert on exploits that span multiple packets in a single session.
 
     [bookmark: pgfId-4413538]The flowbits state name is a user-defined label assigned to packets in a specific part of a session. You can label packets with state names based on packet content to help distinguish malicious packets from those you do not want to alert on. You can define up to 1024 state names per managed device. For example, if you want to alert on malicious packets that you know only occur after a successful login, you can use the flowbits keyword to filter out the packets that constitute an initial login attempt so you can focus only on the malicious packets. You can do this by first creating a rule that labels all packets in the session that have an established login with a logged_in state, then creating a second rule where flowbits checks for packets with the state you set in the first rule and acts only on those packets. See flowbits Example Using state_name for an example that uses flowbits to determine if a user is logged in.
 
     [bookmark: pgfId-4413542]An optional group name allows you to include a state name in a group of states. A state name can belong to several groups. States not associated with a group are not mutually exclusive, so a rule that triggers and sets a state that is not associated with a group does not affect other currently set states. See flowbits Example Resulting in a False Positive for an example that illustrates how including a state name in a group can prevent false positives by unsetting another state in the same group.
 
      
       
        
        [bookmark: pgfId-4916611]Table 36-58 [bookmark: 66765]flowbits Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-4916619]Operator 
          
  
         	 
           
           [bookmark: pgfId-4916621]State Option 
          
  
         	 
           
           [bookmark: pgfId-4916623]Group 
          
  
         	 
           
           [bookmark: pgfId-4916625]Description 
          
  
        
 
         
         	 [bookmark: pgfId-4916627]set
  
         	[bookmark: pgfId-4916629]state_name
  
         	[bookmark: pgfId-4916631]optional
  
         	[bookmark: pgfId-4916633]Sets the specified state for a packet. Sets the state in the specified group if a group is defined.
  
        
 
         
         	[bookmark: pgfId-4916637]state_name&state_name
  
         	[bookmark: pgfId-4916639]optional
  
         	[bookmark: pgfId-4916641]Sets the specified states for a packet. Sets the states in the specified group if a group is defined.
  
        
 
         
         	 [bookmark: pgfId-4916643]setx
  
         	[bookmark: pgfId-4916645]state_name
  
         	[bookmark: pgfId-4916647]mandatory
  
         	[bookmark: pgfId-4916649]Sets the specified state in the specified group for a packet, and unsets all other states in the group.
  
        
 
         
         	[bookmark: pgfId-4916653]state_name&state_name
  
         	[bookmark: pgfId-4916655]mandatory
  
         	[bookmark: pgfId-4916657]Sets the specified states in the specified group for a packet, and unsets all other states in the group.
  
        
 
         
         	 [bookmark: pgfId-4916659]unset
  
         	[bookmark: pgfId-4916661]state_name
  
         	[bookmark: pgfId-4916663]no group
  
         	[bookmark: pgfId-4916665]Unsets the specified state for a packet.
  
        
 
         
         	[bookmark: pgfId-4916669]state_name&state_name
  
         	[bookmark: pgfId-4916671]no group
  
         	[bookmark: pgfId-4916673]Unsets the specified states for a packet.
  
        
 
         
         	[bookmark: pgfId-4916677]all
  
         	[bookmark: pgfId-4916679]mandatory
  
         	[bookmark: pgfId-4916681]Unsets all the states in the specified group.
  
        
 
         
         	 [bookmark: pgfId-4916683]toggle
  
         	[bookmark: pgfId-4916685]state_name
  
         	[bookmark: pgfId-4916687]no group
  
         	[bookmark: pgfId-4916689]Unsets the specified state if it is set, and sets the specified state if it is unset.
  
        
 
         
         	[bookmark: pgfId-4916693]state_name&state_name
  
         	[bookmark: pgfId-4916695]no group
  
         	[bookmark: pgfId-4916697]Unsets the specified states if they are set, and sets the specified states if they are unset.
  
        
 
         
         	[bookmark: pgfId-4916701]all
  
         	[bookmark: pgfId-4916703]mandatory
  
         	[bookmark: pgfId-4916705]Unsets all states set in the specified group, and sets all states unset in the specified group.
  
        
 
         
         	 [bookmark: pgfId-4916707]isset
  
         	[bookmark: pgfId-4916709]state_name
  
         	[bookmark: pgfId-4916711]no group
  
         	[bookmark: pgfId-4916713]Determines if the specified state is set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916717]state_name&state_name
  
         	[bookmark: pgfId-4916719]no group
  
         	[bookmark: pgfId-4916721]Determines if the specified states are set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916725]state_name|state_name 
  
         	[bookmark: pgfId-4916727]no group
  
         	[bookmark: pgfId-4916729]Determines if any of the specified states are set in the packet. 
  
        
 
         
         	[bookmark: pgfId-4916733]any
  
         	[bookmark: pgfId-4916735]mandatory
  
         	[bookmark: pgfId-4916737]Determines if any state is set in the specified group.
  
        
 
         
         	[bookmark: pgfId-4916741]all
  
         	[bookmark: pgfId-4916743]mandatory
  
         	[bookmark: pgfId-4916745]Determines if all states are set in the specified group.
  
        
 
         
         	 [bookmark: pgfId-4916747]isnotset
  
         	[bookmark: pgfId-4916749]state_name
  
         	[bookmark: pgfId-4916751]no group
  
         	[bookmark: pgfId-4916753]Determines if the specified state is not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916757]state_name&state_name
  
         	[bookmark: pgfId-4916759]no group
  
         	[bookmark: pgfId-4916761]Determines if the specified states are not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916765]state_name|state_name
  
         	[bookmark: pgfId-4916767]no group
  
         	[bookmark: pgfId-4916769]Determines if any of the specified states is not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916773]any
  
         	[bookmark: pgfId-4916775]mandatory
  
         	[bookmark: pgfId-4916777]Determines if any state is not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916781]all
  
         	[bookmark: pgfId-4916783]mandatory
  
         	[bookmark: pgfId-4916785]Determines if all states are not set in the packet.
  
        
 
         
         	[bookmark: pgfId-4916787]reset
  
         	[bookmark: pgfId-4916789](no state)
  
         	[bookmark: pgfId-4916791]optional
  
         	[bookmark: pgfId-4916793]Unsets all states for all packets. Unsets all states in a group if a group is specified.
  
        
 
         
         	[bookmark: pgfId-4916795]noalert
  
         	[bookmark: pgfId-4916797](no state)
  
         	[bookmark: pgfId-4916799]no group
  
         	[bookmark: pgfId-4916801]Use this in conjunction with any other operator to suppress event generation.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4450170]Note the following when using the flowbits keyword: 
 
      
      	 [bookmark: pgfId-4490304]When using the  setx operator, the specified state can only belong to the specified group, and not to any other group.
 
      	 [bookmark: pgfId-4490491]You can define the  setx operator multiple times, specifying different states and the same group with each instance.
 
      	 [bookmark: pgfId-4490631]When you use the  setx operator and specify a group, you cannot use the  set ,  toggle , or  unset operators on that specified group.
 
      	 [bookmark: pgfId-4491151]The  isset and  isnotset operators evaluate for the specified state regardless of whether the state is in a group.
 
      	 [bookmark: pgfId-4491716]During intrusion policy saves, intrusion policy reapplies, and access control policy applies (regardless of whether the access control policy references one intrusion policy or multiple intrusion policies), if you enable a rule that contains the  isset or  isnotset operator  without a specified group, and you do not enable at least one rule that affects  flowbits assignment ( set ,  setx ,  unset ,  toggle ) for the corresponding state name and protocol, all rules that affect  flowbits assignment for the corresponding state name are enabled.
 
      	 [bookmark: pgfId-4798151]During intrusion policy saves, intrusion policy reapplies, and access control policy applies (regardless of whether the access control policy references one intrusion policy or multiple intrusion policies), if you enable a rule that contains the  isset or  isnotset operator  with a specified group, all rules that affect  flowbits assignment ( set ,  setx ,  unset ,  toggle ) and define a corresponding group name are also enabled.
 
     
 
     [bookmark: pgfId-3720100][bookmark: 46849]flowbits Example Using state_name
 
     [bookmark: pgfId-3720101]Consider the IMAP vulnerability described in Bugtraq ID #1110. This vulnerability exists in an implementation of IMAP, specifically in the LIST, LSUB, RENAME, FIND, and COPY commands. However, to take advantage of the vulnerability, the attacker must be logged into the IMAP server. Because the LOGIN confirmation from the IMAP server and the exploit that follows are necessarily in different packets, it is difficult to construct non-flow-based rules that catch this exploit. Using the flowbits keyword, you can construct a series of rules that track whether the user is logged into the IMAP server and, if so, generate an event if one of the attacks is detected. If the user is not logged in, the attack cannot exploit the vulnerability and no event is generated.
 
     [bookmark: pgfId-4467870]The two rule fragments that follow illustrate this example. The first rule fragment looks for an IMAP login confirmation from the IMAP server:
 
      
      [bookmark: pgfId-3720103]alert tcp any 143 -> any any (msg:"IMAP login"; content:"OK
LOGIN"; flowbits:set,logged_in; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720104]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5001575]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4467938]Note that flowbits:set sets a state of logged_in, while flowbits:noalert suppresses the alert because you are likely to see many innocuous login sessions on an IMAP server.
 
     [bookmark: pgfId-3720105]The next rule fragment looks for a LIST string, but does not generate an event unless the logged_in state has been set as a result of some previous packet in the session: 
 
      
      [bookmark: pgfId-3720106]alert tcp any any -> any 143 (msg:"IMAP LIST";
content:"LIST"; flowbits:isset,logged_in;) 
     
 
     [bookmark: pgfId-3720107]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5001599]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468065]In this case, if a previous packet has caused a rule containing the first fragment to trigger, then a rule containing the second fragment triggers and generates an event.
 
     [bookmark: pgfId-3720109][bookmark: 89941]flowbits Example Resulting in a False Positive
 
     [bookmark: pgfId-3720110]Including different state names that are set in different rules in a group can prevent false positive events that might otherwise occur when content in a subsequent packet matches a rule whose state is no longer valid. The following example illustrates how you can get false positives when you do not include multiple state names in a group.
 
     [bookmark: pgfId-4467898]Consider the case where the following three rule fragments trigger in the order shown during a single session:
 
      
      [bookmark: pgfId-3720112](msg:"JPEG transfer"; content:"image/";pcre:"/^Content-
Type\x3a(\s*|\s*\r?\n\s+)image\x2fp?jpe?g/smi";
flowbits:set,http.jpeg; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720113]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5001623]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468145]The content and pcre keywords in the first rule fragment match a JPEG file download, flowbits:set,http.jpeg sets the http.jpeg flowbits state, and flowbits:noalert stops the rule from generating events. No event is generated because the rule’s purpose is to detect the file download and set the flowbits state so one or more companion rules can test for the state name in combination with malicious content and generate events when malicious content is detected.
 
     [bookmark: pgfId-3720114]The next rule fragment detects a GIF file download subsequent to the JPEG file download above:
 
      
      [bookmark: pgfId-3720115](msg:"GIF transfer"; content:"image/"; pcre:"/^Content-
Type\x3a(\s*|\s*\r?\n\s+)image\x2fgif/smi";
flowbits:set,http.tif,image_downloads; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720116]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5001647]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468171]The content and pcre keywords in the second rule match the GIF file download, flowbits:set,http.tif sets the http.tif flowbit state, and flowbits:noalert stops the rule from generating an event. Note that the http.jpeg state set by the first rule fragment is still set even though it is no longer needed; this is because the JPEG download must have ended if a subsequent GIF download has been detected.
 
     [bookmark: pgfId-3720117]The third rule fragment is a companion to the first rule fragment:
 
      
      [bookmark: pgfId-3720118](msg:"JPEG exploit";
flowbits:isset,http.jpeg;content:"|FF|"; pcre:"
/\xFF[\xE1\xE2\xED\xFE]\x00[\x00\x01]/";) 
     
 
     [bookmark: pgfId-3720119]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5001671]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468190]In the third rule fragment, flowbits:isset,http.jpeg determines that the now-irrelevant http.jpeg state is set, and content and pcre match content that would be malicious in a JPEG file but not in a GIF file. The third rule fragment results in a false positive event for a nonexistent exploit in a JPEG file.
 
     [bookmark: pgfId-4451743]flowbits Example for Preventing False Positives
 
     [bookmark: pgfId-4451782]The following example illustrates how including state names in a group and using the setx operator can prevent false positives. 
 
     [bookmark: pgfId-4467935]Consider the same case as the previous example, except that the first two rules now include their two different state names in the same state group.
 
      
      [bookmark: pgfId-3720121](msg:"JPEG transfer"; content:"image/";pcre:"/^Content-
Type\x3a(\s*|\s*\r?\n\s+)image\x2fp?jpe?g/smi";
flowbits:setx,http.jpeg,image_downloads; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720122]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5001695]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468238]When the first rule fragment detects a JPEG file download, the flowbits:setx,http.jpeg,image_downloads keyword sets the flowbits state to http.jpeg and includes the state in the image_downloads group. 
 
     [bookmark: pgfId-4454112]The next rule then detects a subsequent GIF file download:
 
      
      [bookmark: pgfId-3720124](msg:"GIF transfer"; content:"image/"; pcre:"/^Content-
Type\x3a(\s*|\s*\r?\n\s+)image\x2fgif/smi";
flowbits:setx,http.tif,image_downloads; flowbits:noalert;) 
     
 
     [bookmark: pgfId-3720125]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5001719]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468271]When the second rule fragment matches the GIF download, the flowbits:setx,http.tif,image_downloads keyword sets the http.tif flowbits state and unsets http.jpeg, the other state in the group.
 
     [bookmark: pgfId-3720126]The third rule fragment does not result in a false positive:
 
      
      [bookmark: pgfId-3720127](msg:"JPEG exploit"; 
flowbits:isset,http.jpeg;content:"|FF|"; pcre:"/
\xFF[\xE1\xE2\xED\xFE]\x00[\x00\x01]/";) 
     
 
     [bookmark: pgfId-3720128]The following diagram illustrates the effect of the flowbits keyword in the preceding rule fragment:
 
     [bookmark: pgfId-5001743]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4468306]Because flowbits:isset,http.jpeg is false, the rules engine stops processing the rule and no event is generated, thus avoiding a false positive even in a case where content in the GIF file matches exploit content for a JPEG file.
 
    
 
     
      [bookmark: pgfId-3720130][bookmark: 69548]Generating Events on the HTTP Encoding Type and Location
 
     [bookmark: pgfId-4239128]License: Protection
 
     [bookmark: pgfId-3720136]You can use the http_encode[bookmark: marker-3720135] keyword to generate events on the type of encoding in an HTTP request or response before normalization, either in the HTTP URI, in non-cookie data in an HTTP header, in cookies in HTTP requests headers, or set-cookie data in HTTP responses.
 
     [bookmark: pgfId-3720144]You must configure the HTTP Inspect preprocessor to inspect HTTP responses and HTTP cookies to return matches for rules using the http_encode keyword. See Decoding HTTP Traffic and Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-3720151]Also, you must enable both the decoding and alerting option for each specific encoding type in your HTTP Inspect preprocessor configuration for the http_encode keyword in an intrusion rule to trigger events on that encoding type. See Selecting Server-Level HTTP Normalization Encoding Options for more information.
 
     [bookmark: pgfId-4227731]Note that the base36 encoding type has been deprecated. For backward compatibility, the base36 argument is allowed in existing rules, but it does not cause the rules engine to inspect base36 traffic.
 
      
       
        
        [bookmark: pgfId-3720165]Table 36-59 [bookmark: 78097]http_encode Encoding Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-3720169]Encoding Type 
          
  
         	 
           
           [bookmark: pgfId-3720171]Description 
          
  
        
 
         
         	[bookmark: pgfId-3720173]utf8
  
         	[bookmark: pgfId-3720175]Detects UTF-8 encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.
  
        
 
         
         	[bookmark: pgfId-3720177]double_encode
  
         	[bookmark: pgfId-3720179]Detects double encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.
  
        
 
         
         	[bookmark: pgfId-3720181]non_ascii
  
         	[bookmark: pgfId-3720183]Detects non-ASCII characters in the specified location when non-ASCII characters are detected but the detected encoding type is not enabled.
  
        
 
         
         	[bookmark: pgfId-3720189]uencode
  
         	[bookmark: pgfId-3720191]Detects Microsoft %u encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.
  
        
 
         
         	[bookmark: pgfId-3720193]bare_byte
  
         	[bookmark: pgfId-3720195]Detects bare byte encoding in the specified location when this encoding type is enabled for decoding by the HTTP Inspect preprocessor.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3720197]To identify the HTTP encoding type and location in an intrusion rule:
 
     [bookmark: pgfId-4241136]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-3720199]Step 1 Add the http_encode keyword to a rule.
 
     [bookmark: pgfId-3720200]Step 2 From the Encoding Location drop-down list, select whether to search for the specified encoding type in an HTTP URI, header, or cookie, including a set-cookie.
 
     [bookmark: pgfId-3720201]Step 3 Specify one or more encoding types using one of the following formats:
 
      
      [bookmark: pgfId-3720202]encode_type 
     
 
      
      [bookmark: pgfId-3720203]encode_type|encode_type|encode_type... 
     
 
      
      [bookmark: pgfId-3720204]!encode_type 
     
 
     [bookmark: pgfId-3720205]where encode_type is one of the following:
 
      
      [bookmark: pgfId-3720206]utf8, double_encode, non_ascii, uencode, bare_byte 
     
 
     [bookmark: pgfId-3720207]Note that you cannot use the negation (!) and OR (|) operators together.
 
     [bookmark: pgfId-3720208]Step 4 Optionally, add multiple http_encode keywords to the same rule to AND the conditions for each. For example, enter two keywords with the following conditions:
 
     [bookmark: pgfId-3720209]First http_encode keyword:
 
      
       
       	 [bookmark: pgfId-3720210] Encoding Location :  HTTP UR I
 
       	 [bookmark: pgfId-3720211] Encoding Type :  utf8 
 
      
 
     
 
     [bookmark: pgfId-3720212]Additional http_encode keyword:
 
      
       
       	 [bookmark: pgfId-3720213] Encoding Location :  HTTP URI 
 
       	 [bookmark: pgfId-3720214] Encoding Type :  uencode 
 
      
 
     
 
     [bookmark: pgfId-3720215]The example configuration searches the HTTP URI for UTF-8 AND Microsoft IIS %u encoding.
 
     [bookmark: pgfId-4776955]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4860915][bookmark: 19614]Detecting File Types and Versions
 
     [bookmark: pgfId-4860922]License:  Protection
 
     [bookmark: pgfId-4876530]The file_type and file_group keywords allow you to detect files transmitted via FTP, HTTP, SMTP, IMAP, POP3, and NetBIOS-ssn (SMB) based on their type and version. Do not use more than one file_type or file_group keyword in a single intrusion rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860925]Tip Updating your vulnerability database (VDB) populates the rule editor with the most up-to-date file types, versions, and groups. For more information, see Updating the Vulnerability Database.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-4893177]Table 36-60 file_type and file_group Intrusion Event Generation 
 
        
        
         
         	 
           
           [bookmark: pgfId-4893181]Transmission Protocol 
          
  
         	 
           
           [bookmark: pgfId-4893183]Required Preprocessor or Preprocessor Option 
          
  
        
 
         
         	[bookmark: pgfId-4893185]FTP
  
         	[bookmark: pgfId-4893187]FTP/Telnet preprocessor and the Normalize TCP Payload inline normalization preprocessor option; see Decoding FTP and Telnet Traffic and Normalizing Inline Traffic.
  
        
 
         
         	[bookmark: pgfId-4893189]HTTP
  
         	[bookmark: pgfId-4893191]HTTP Inspect preprocessor; see Decoding HTTP Traffic.
  
        
 
         
         	[bookmark: pgfId-4893193]SMTP
  
         	[bookmark: pgfId-4893195]SMTP preprocessor; see Decoding SMTP Traffic.
  
        
 
         
         	[bookmark: pgfId-4893197]IMAP
  
         	[bookmark: pgfId-4893199]IMAP preprocessor; see Decoding IMAP Traffic.
  
        
 
         
         	[bookmark: pgfId-4893201]POP3
  
         	[bookmark: pgfId-4893203]POP preprocessor; see Decoding POP Traffic.
  
        
 
         
         	[bookmark: pgfId-4893205]NetBIOS-ssn (SMB)
  
         	[bookmark: pgfId-4893207]the SMB File Inspection DCE/RPC preprocessor option; see Decoding DCE/RPC Traffic.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4891464]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-4860933]file_type
 
      	 [bookmark: pgfId-4876152]file_group
 
     
 
    
 
     
      [bookmark: pgfId-4876154][bookmark: 28097]file_t[bookmark: marker-4876605]ype
 
     [bookmark: pgfId-4876112]The file_type keyword allows you to specify the file type and version of a file detected in traffic. File type arguments (for example, JPEG and PDF) identify the format of the file you want to find in traffic. 
 
      
       
     
 
     
 
     [bookmark: pgfId-4929042]Note Do not use the file_type keyword with another file_type or file_group keyword in the same intrusion rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860942]The system selects Any Version by default, but some file types allow you to select version options (for example, PDF version 1.7) to identify specific file type versions you want to find in traffic.
 
     [bookmark: pgfId-4860943]To view and configure the most up-to-date file types and versions, update your VDB. For more information, see Updating the Vulnerability Database.
 
     [bookmark: pgfId-4860947]To select file types and versions in an intrusion rule:
 
     [bookmark: pgfId-4876098]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4876099]Step 1 On the Create Rule page, select file_type from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4876100]The file_type keyword appears.
 
     [bookmark: pgfId-4876086]Step 2 Select one or more file types from the drop-down list. Selecting a file type automatically adds the argument to the rule.
 ) next to the file type you want to remove. 
     
 
     [bookmark: pgfId-4860959]Step 3 Optionally, customize the target versions for each file type. The system selects Any Version by default, but some file types allow you to select individual target versions.
 
      
       
     
 
     
 
     [bookmark: pgfId-4860960]Note Updating your VDB populates the rule editor with the most up-to-date file types and versions. If you select Any Version, the system configures your rule to include new versions when they are added in later VDB updates.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4860961]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4876076][bookmark: 12593]file_[bookmark: marker-4876610]group
 
     [bookmark: pgfId-4860968]The file_group keyword allows you to select a Cisco-defined group of similar file types to find in traffic (for example, multimedia or audio). File groups also include Cisco-defined versions for each file type in the group.
 
      
       
     
 
     
 
     [bookmark: pgfId-4929497]Note Do not use the file_group keyword with another file_group or file_type keyword in the same intrusion rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4929498]To view and configure the most up-to-date file groups, update your VDB. For more information, see Updating the Vulnerability Database.
 
     [bookmark: pgfId-4860976]To select a file group in an intrusion rule:
 
     [bookmark: pgfId-4860980]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4860981]Step 1 On the Create Rule page, select file_group from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4860982]The file_group keyword appears.
 
     [bookmark: pgfId-4860983]Step 2 Optionally, to view version information for the file types in a group, hover your pointer over the file group and click on (Show Version Info).
 
     [bookmark: pgfId-4860984]The file group information expands to show the versions.
 
     [bookmark: pgfId-4860985]Step 3 Select a file group to add to the rule.
 
     [bookmark: pgfId-4860986]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4796353][bookmark: 90176]Pointing to a Specific Payload Type
 
     [bookmark: pgfId-4239141]License: Protection
 
     [bookmark: pgfId-4080034]The file_data keyword provides a pointer that serves as a reference for the positional arguments available for other keywords such as content, byte_jump, byte_test, and pcre. The detected traffic determines the type of data the file_data keyword points to. You can use the file_data[bookmark: marker-4080035] keyword to point to the beginning of the following payload types:
 
      
      	 [bookmark: pgfId-4929479]HTTP response body
 
     
 
     [bookmark: pgfId-4929480]To inspect HTTP response packets, the HTTP Inspect preprocessor must be enabled and you must configure the preprocessor to inspect HTTP responses. See Decoding HTTP Traffic and Inspect HTTP Responses in Selecting Server-Level HTTP Normalization Options for more information. The file_data keyword matches if the HTTP Inspect preprocessor detects HTTP response body data.
 
      
      	 [bookmark: pgfId-4929441]Uncompressed gzip file data
 
     
 
     [bookmark: pgfId-4929442]To inspect uncompressed gzip files in the HTTP response body, the HTTP Inspect preprocessor must be enabled and you must configure the preprocessor to inspect HTTP responses and to decompress gzip-compressed files in the HTTP response body. For more information, see Decoding HTTP Traffic, and the Inspect HTTP Responses and Inspect Compressed Data options in Selecting Server-Level HTTP Normalization Options. The file_data keyword matches if the HTTP Inspect preprocessor detects uncompressed gzip data in the HTTP response body. 
 
      
      	 [bookmark: pgfId-4929411]Normalized JavaScript
 
     
 
     [bookmark: pgfId-4929412]To inspect normalized JavaScript data, the HTTP Inspect preprocessor must be enabled and you must configure the preprocessor to inspect HTTP responses. See Decoding HTTP Traffic and Inspect HTTP Responses in Selecting Server-Level HTTP Normalization Options for more information. The file_data keyword matches if the HTTP Inspect preprocessor detects JavaScript in response body data.
 
      
      	 [bookmark: pgfId-4929393]SMTP payload
 
     
 
     [bookmark: pgfId-4929396]To inspect the SMTP payload, the SMTP preprocessor must be enabled. See Configuring SMTP Decoding for more information. The file_data keyword matches if the SMTP preprocessor detects SMTP data.
 
      
      	 [bookmark: pgfId-4929390]Encoded email attachments in SMTP, POP, or IMAP traffic
 
     
 
     [bookmark: pgfId-4929644]To inspect email attachments in SMTP, POP, or IMAP traffic, the SMTP, POP, or IMAP preprocessor, respectively, must be enabled, alone or in any combination. Then, for each enabled preprocessor, you must ensure that the preprocessor is configured to decode each attachment encoding type that you want decoded. The attachment decoding options that you can configure for each preprocessor are: Base64 Decoding Depth, 7-Bit/8-Bit/Binary Decoding Depth, Quoted-Printable Decoding Depth, and Unix-to-Unix Decoding Depth. See Decoding IMAP Traffic, Decoding POP Traffic, and Decoding SMTP Traffic for more information.
 
     [bookmark: pgfId-4929691]You can use multiple file_data keywords in a rule.
 
     [bookmark: pgfId-4929693]To point to the beginning of a specific payload type:
 
     [bookmark: pgfId-4249174]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4215207]Step 1 On the Create Rule page, select file_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4215208]The file_data keyword appears.
 
     [bookmark: pgfId-4215259]The file_data keyword has no arguments.
 
     [bookmark: pgfId-4776961]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4216237][bookmark: 32633]Pointing to the Beginning of the Packet Payload
 
     [bookmark: pgfId-4239164]License: Protection
 
     [bookmark: pgfId-4215275]The pkt_data[bookmark: marker-4215274] keyword provides a pointer that serves as a reference for the positional arguments available for other keywords such as content, byte_jump, byte_test, and pcre.
 
     [bookmark: pgfId-4385996]When normalized FTP, telnet, or SMTP traffic is detected, the pkt_data keyword points to the beginning of the normalized packet payload. When other traffic is detected, the pkt_data keyword points to the beginning of the raw TCP or UDP payload.
 
     [bookmark: pgfId-4386088]The following normalization options must be enabled for the system to normalize the corresponding traffic for inspection by intrusion rules:
 
      
      	 [bookmark: pgfId-4386017]To normalize FTP traffic for inspection, you must enable the FTP and Telnet preprocessor  Detect Telnet Escape codes within FTP commands option; see Configuring Server-Level FTP Options.
 
      	 [bookmark: pgfId-4386031]To normalize telnet traffic for inspection, you must enable the FTP & Telnet preprocessor  Normalize telnet option; see Understanding Telnet Options.
 
      	 [bookmark: pgfId-4386009]To normalize SMTP traffic for inspection, you must enable the SMTP preprocessor  Normalize option; see Understanding SMTP Decoding.
 
     
 
     [bookmark: pgfId-4386002]You can use multiple pkt_data keywords in a rule.
 
     [bookmark: pgfId-4385956]To point to the beginning of the packet payload:
 
     [bookmark: pgfId-4241168]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4215280]Step 1 On the Create Rule page, select pkt_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4215281]The pkt_data keyword appears.
 
     [bookmark: pgfId-4019186]The pkt_data keyword has no arguments.
 
     [bookmark: pgfId-4776967]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4215225][bookmark: 43136]Decoding and Inspecting Bas[bookmark: marker-4019292]e6[bookmark: marker-4019301]4 Data
 
     [bookmark: pgfId-4239177]License: Protection
 
     [bookmark: pgfId-4029444]You can use the base64_decode and base64_data keywords in combination to instruct the rules engine to decode and inspect specified data as Base64 data. This can be useful, for example, for inspecting Base64-encoded HTTP Authentication request headers and Base64-encoded data in HTTP PUT and POST requests.
 
     [bookmark: pgfId-4030458]These keywords are particularly useful for decoding and inspecting Base64 data in HTTP requests. However, you can also use them with any protocol such as SMTP that uses the space and tab characters the same way HTTP uses these characters to extend a lengthy header line over multiple lines. When this line extension, which is known as folding, is not present in a protocol that uses it, inspection ends at any carriage return or line feed that is not followed with a space or tab.
 
     [bookmark: pgfId-4024197]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4024205]base64_decode
 
      	 [bookmark: pgfId-4024212]base64_data
 
     
 
    
 
     
      [bookmark: pgfId-4024230][bookmark: 34673]base64_decode
 
     [bookmark: pgfId-4239190]License: Protection
 
     [bookmark: pgfId-4024427]The base64_decode keyword instructs the rules engine to decode packet data as Base64 data. Optional arguments let you specify the number of bytes to decode and where in the data to begin decoding.
 
     [bookmark: pgfId-4024237]You can use the base64_decode keyword once in a rule; it must precede at least one instance of the base64_data keyword. See base64_data for more information.
 
     [bookmark: pgfId-4024845]Before decoding Base64 data, the rules engine unfolds lengthy headers that are folded across multiple lines. Decoding ends when the rules engine encounters any the following:
 
      
      	 [bookmark: pgfId-4024846]the end of a header line
 
      	 [bookmark: pgfId-4024847]the specified number of bytes to decode
 
      	 [bookmark: pgfId-4024848]the end of the packet
 
     
 
      
       
        
        [bookmark: pgfId-4024859]Table 36-61 [bookmark: 74525]Optional base64_decode Arguments 
 
        
        
         
         	 
           
           [bookmark: pgfId-4024863]Argument 
          
  
         	 
           
           [bookmark: pgfId-4024865]Description 
          
  
        
 
         
         	[bookmark: pgfId-4024867]Bytes
  
         	[bookmark: pgfId-4024869]Specifiesthenumberofbytestodecode. When not specified, decoding continues to the end of a header line or the end of the packet payload, whichever comes first. You can specify a positive, non-zero value.
  
        
 
         
         	[bookmark: pgfId-4024871]Offset
  
         	[bookmark: pgfId-4024873]Determines the offset relative to the start of the packet payload or, when you also specify Relative, relative to the current inspection location. You can specify a positive, non-zero value.
  
        
 
         
         	[bookmark: pgfId-4024875]Relative
  
         	[bookmark: pgfId-4024877]Specifies inspection relative to the current inspection location.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4025447]To decode Base64 data:
 
     [bookmark: pgfId-4241182]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4024976]Step 1 On the Create Rule page, select base64_decode from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4024977]The base64_decode keyword appears.
 
     [bookmark: pgfId-4024984]Step 2 Optionally, select any of the arguments described in the Optional base64_decode Arguments table.
 
     [bookmark: pgfId-4776981]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4024263][bookmark: 75305]base64_data
 
     [bookmark: pgfId-4239212]License: Protection
 
     [bookmark: pgfId-4024274]The base64_data keyword provides a reference for inspecting Base64 data decoded using the base64_decode keyword. The base64_data keyword sets inspection to begin at the start of the decoded Base64 data. Optionally, you can then use the positional arguments available for other keywords such as content or byte_test to further specify the location to inspect.
 
     [bookmark: pgfId-4028570]You must use the base64_data keyword at least once after using the base64_decode keyword; optionally, you can use base64_data multiple times to return to the beginning of the decoded Base64 data.
 
     [bookmark: pgfId-4030110]Note the following when inspecting Base64 data:
 
      
      	 [bookmark: pgfId-4030111]You cannot use the fast pattern matcher; see Use Fast Pattern Matcher for more information.
 
      	 [bookmark: pgfId-4030115]If you interrupt Base64 inspection in a rule with an intervening HTTP content argument, you must insert another  base64_data  keyword in the rule before further inspecting Base64 data; see HTTP Content Options for more information.
 
     
 
     [bookmark: pgfId-4028573]To inspect decoded Base64 data:
 
     [bookmark: pgfId-4241198]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4028585]Step 1 On the Create Rule page, select base64_data from the drop-down list and click Add Option.
 
     [bookmark: pgfId-4028586]The base64_data keyword appears.
 
     [bookmark: pgfId-4776987]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4019583][bookmark: 84829]Constructing a[bookmark: marker-4019582] Rule
 
    [bookmark: pgfId-4239230]License: Protection
 
    [bookmark: pgfId-2507268]Just as you can create your own custom standard text rules, you can also modify existing standard text rules and shared object rule provided by Cisco and save your changes as a new rule. Note that for shared object rules provided by Cisco, you are limited to modifying rule header information such as the source and destination ports and IP addresses. You cannot modify the rule keywords and arguments in a shared object rule.
 
    [bookmark: pgfId-2507295]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1095404]Writing New Rules
 
     	 [bookmark: pgfId-1095408]Modifying Existing Rules
 
     	 [bookmark: pgfId-2476910]Adding Comments to Rules
 
     	 [bookmark: pgfId-2020997]Deleting Custom Rules
 
    
 
     
      [bookmark: pgfId-1095411][bookmark: 41970]Writing New[bookmark: marker-2334571] Rules
 
     [bookmark: pgfId-4239247]License: Protection
 
     [bookmark: pgfId-2594423]You can create your own standard text rules.
 
     [bookmark: pgfId-2804966]In a custom standard text rule, you set the rule header settings and the rule keywords and arguments. Optionally, you can use the rule header settings to focus the rule to only match traffic using a specific protocol and traveling to or from specific IP addresses or ports.
 
     [bookmark: pgfId-2506899]After you create a new rule, you can find it again quickly using the rule number, which has the format GID:SID:Rev. The rule number for all standard text rules starts with 1. The second part of the rule number, the Snort ID (SID) number, indicates whether the rule is a local rule or a rule provided by Cisco. When you create a new rule, the system assigns the rule the next available Snort ID number for a local rule and saves the rule in the local rule category. Snort ID numbers for local rules start at 1,000,000 (although intrusion rules created on the secondary Defense Center in a high availability pair begin with the number 1,000,000,000) and the SID for each new local rule is incremented by one. The last part of the rule number is the revision number. For a new rule, the revision number is one. Each time you modify a custom rule the revision number increments by one.
 
      
       
     
 
     
 
     [bookmark: pgfId-2506911]Note The system assigns a new SID to any custom rule in an intrusion policy that you import. For more information, see Importing and Exporting Configurations.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2506886]To write a custom standard text rule using the rule editor:
 
     [bookmark: pgfId-4241212]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1932019]Step 1 Select Policies > Intrusion > Rule Editor.
 
     [bookmark: pgfId-1938391]The Rule Editor page appears.
 
     [bookmark: pgfId-1938393]Step 2 Click Create Rule.
 
     [bookmark: pgfId-2014599]The Create Rule page appears.
 
     [bookmark: pgfId-1095421]Step 3 In the Message field, enter the message you want displayed with the event. 
 
     [bookmark: pgfId-1203883]For details on event messages, see Defining the Event Message.
 
      
       
     
 
     
 
     [bookmark: pgfId-2288901]Tip You must specify a rule message. Also, the message cannot consist of white space only, one or more quotation marks only, one or more apostrophes only, or any combination of just white space, quotation marks, or apostrophes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1203882]Step 4 From the Classification list, select a classification to describe the type of event.
 
     [bookmark: pgfId-1203895]For details on available classifications, see Defining the Intrusion Event Classification.
 
     [bookmark: pgfId-1203887]Step 5 From the Action list, select the type of rule you would like to create. You can use one of the following:
 
      
       
       	 [bookmark: pgfId-1095422]Select  alert to create a rule that generates an event when traffic triggers the rule.
 
       	 [bookmark: pgfId-1095423]Select  pass to create a rule that ignores traffic that triggers the rule.
 
      
 
     
 
     [bookmark: pgfId-1095424]Step 6 From the Protocol list, select the traffic protocol (tcp, udp, icmp, or ip) of packets you want the rule to inspect.
 
     [bookmark: pgfId-1095427]For more information about selecting a protocol type, see Specifying Protocols.
 
     [bookmark: pgfId-3148405]Step 7 In the Source IPs field, enter the originating IP address or address block for traffic that should trigger the rule. In the Destination IPs field, enter the destination IP address or address block for traffic that should trigger the rule.
 
     [bookmark: pgfId-3148406]For more detailed information about the IP address syntax that the rule editor accepts, see Specifying IP Addresses In Intrusion Rules.
 
     [bookmark: pgfId-1095440]Step 8 In the Source Port field, enter the originating port numbers for traffic that should trigger the rule. In the Destination Port field, enter the receiving port numbers for traffic that should trigger the rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-3148422]Note The system ignores port definitions in an intrusion rule header when the protocol is set to ip.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3148416]For more detailed information about the port syntax that the rule editor accepts, see Defining Ports in Intrusion Rules.
 
     [bookmark: pgfId-1095450]Step 9 From the Direction list, select the operator that indicates which direction of traffic you want to trigger the rule. You can use one of the following:
 
      
       
       	 [bookmark: pgfId-1095451] Directional to match traffic that moves from the source IP address to the destination IP address
 
       	 [bookmark: pgfId-1095452] Bidirectional to match traffic that moves in either direction
 
      
 
     
 
     [bookmark: pgfId-1253301]Step 10 [bookmark: 19542]From the Detection Options list, select the keyword that you want to use.
 
     [bookmark: pgfId-1255399]Step 11 [bookmark: 29624]Click Add Option.
 
     [bookmark: pgfId-2014646]Step 12 [bookmark: 16848]Enter any arguments that you want to specify for the keyword you added. For more information about rule keywords and how to use them, see Understanding Keywords and Arguments in Rules.
 
     [bookmark: pgfId-2014737]When adding keywords and arguments, you can also perform the following:
 
      
       
       	 [bookmark: pgfId-2014738]To reorder keywords after you add them, click the up or down arrow next to the keyword you want to move.
 
       	 [bookmark: pgfId-2014739]To delete a keyword, click the  X next to that keyword.
 
      
 
     
 
     [bookmark: pgfId-1095487]Repeat steps 10 through 12 for each keyword option you want to add. 
 
     [bookmark: pgfId-2015057]Step 13 Click Save As New to save the rule.
 
     [bookmark: pgfId-2015084]The system assigns the rule the next available Snort ID (SID) number in the rule number sequence for local rules and saves it in the local rule category. 
 
     [bookmark: pgfId-4383252]The system does not begin evaluating traffic against new or changed rules until you enable them within the appropriate intrusion policy, and then apply the intrusion policy as part of an access control policy. See Applying an Access Control Policy for more information.
 
     [bookmark: pgfId-4777009]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4383259][bookmark: 83996]Modifying Existing[bookmark: marker-4383258] Rules
 
     [bookmark: pgfId-4239260]License: Protection
 
     [bookmark: pgfId-2506965]You can modify custom standard text rules. You can also modify a standard text rule or shared object rule provided by Cisco and create one or more new instances of the rule by saving it.
 
     [bookmark: pgfId-2805116]Creating a rule or modifying a Cisco rule copies the new rule or revision to the local rule category and assigns the rule the next available Snort ID (SID) greater than 100000.
 
     [bookmark: pgfId-4161618]You can only modify header information for a shared object rule. You cannot modify the rule keywords used in a shared object rule or their arguments. Modifying header information for a shared object rule and saving your changes creates a new instance of the rule with a generator ID (GID) of 3 and the next available SID for a custom rule. The Rule Editor links the new instance of the shared object rule to the reserved soid keyword, which maps the rule you create to the rule created by the VRT. You can delete instances of a shared object rule that you create, but you cannot delete shared object rules provided by Cisco. See Understanding Rule Headers and Deleting Custom Rules for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-4169717]Note Do not modify the protocol for a shared object rule; doing so would render the rule ineffective.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1100200]To modify a rule:
 
     [bookmark: pgfId-4241229]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1932049]Step 1 Select Policies > Intrusion > Rule Editor.
 
     [bookmark: pgfId-1897482]The Rule Editor page appears.
 
     [bookmark: pgfId-3007568]Step 2 Locate the rule or rules you want to modify. You have the following options:
 
      
       
       	 [bookmark: pgfId-3007569]To locate rules by browsing rule categories, navigate through the folders to the rule you want and click the edit icon (
 
      
 
      [image: ] ) next to the rule. 
     
 
      
       
       	 [bookmark: pgfId-4681663]To locate rules by searching for them, enter the search criteria (most simply, the SID) for the rule or rules you want and click  Search . Click a rule returned by the search as appropriate. See Searching for Rules for more information.
 
       	 [bookmark: pgfId-3048207]To locate a rule or rules by filtering the rules displayed on the page, enter a rule filter in the text box indicated by the filter icon (
 
      
 
      [image: ] ) at the upper left of the rule list. Navigate to the rule you want and click the edit icon ( 
      [image: ] ) next to the rule. See 
      Filtering Rules on the Rule Editor Page for more information. 
     
 
     [bookmark: pgfId-3631181]The rule editor opens, displaying the rule you selected.
 
     [bookmark: pgfId-3631245]Note that if you select a shared object rule, the rule editor displays only the rule header information. A shared object rule can be identified on the Rule Editor page by a listing that begins with the number 3 (the GID), for example, 3:1000004.
 
     [bookmark: pgfId-1777587]Step 3 Make any modifications to the rule (see Writing New Rules for more information about rule options) and click Save As New.
 
     [bookmark: pgfId-1095568]The rule is saved to the local rule category. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1095569]Tip If you want to use the local modification of the rule instead of the system rule, deactivate the system rule by using the procedures at Setting Rule States and activate the local rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1095575]Step 4 Activate the intrusion policy by applying it as part of an access control policy as described in Applying an Access Control Policy to apply your changes.
 
     [bookmark: pgfId-4777015]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1513335][bookmark: 83751]Adding[bookmark: marker-2334573] Comments to Rules
 
     [bookmark: pgfId-4239286]License: Protection
 
     [bookmark: pgfId-1516445]You can add comments to any intrusion rule. This allows you to provide additional context and information about the rule and the exploit or policy violation it identifies.
 
     [bookmark: pgfId-1513389]To add a comment to a rule:
 
     [bookmark: pgfId-4241247]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-1897517]Step 1 Select Policies > Intrusion > Rule Editor. 
 
     [bookmark: pgfId-3007481]The Rule Editor page appears.
 
     [bookmark: pgfId-3007475]Step 2 Locate the rule you want to annotate. You have the following options:
 
      
       
       	 [bookmark: pgfId-2959639]To locate a rule by browsing rule categories, navigate through the folders to the rule you want and click the edit icon (
 
      
 
      [image: ] ) next to the rule. 
     
 
      
       
       	 [bookmark: pgfId-2954246]To locate a rule by searching for it, enter the search criteria (most simply, the SID) for the rule you want and click  Search . Click the rule returned by the search as appropriate. See Searching for Rules for more information.
 
       	 [bookmark: pgfId-3007413]To locate a rule by filtering the rules displayed on the page, enter a rule filter in the text box, which is indicated by the filter icon (
 
      
 
      [image: ] ), at the upper left of the rule list. Navigate to the rule you want and click the edit icon ( 
      [image: ] ) next to the rule. See 
      Filtering Rules on the Rule Editor Page for more information. 
     
 
     [bookmark: pgfId-2954214]The rule editor appears.
 
     [bookmark: pgfId-2954215]Step 3 Click Rule Comment.
 
     [bookmark: pgfId-1513443]The Rule Comment page appears.
 
     [bookmark: pgfId-1513444]Step 4 Enter your comment in the text box and click Add Comment.
 
     [bookmark: pgfId-1513445]The comment is saved in the comment text box.
 
      
       
     
 
     
 
     [bookmark: pgfId-1972866]Tip You can also add and view rule comments in an intrusion event’s packet view. For more information, see Viewing Event Information. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4777050]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2466837][bookmark: 71747]Deleting Custom Rules
 
     [bookmark: pgfId-4239306]License: Protection
 
     [bookmark: pgfId-2466839]You can delete custom rules that are not currently enabled in an intrusion policy. You cannot delete either standard text rules or shared object rules rules provided by Cisco. 
 
     [bookmark: pgfId-4072447]The system stores deleted rules in the deleted category, and you can use a deleted rule as the basis for a new rule. See Modifying Existing Rules for information on editing rules.
 
     [bookmark: pgfId-2530005]The Rules page in an intrusion policy does not display the deleted category, so you cannot enable deleted custom rules.
 
     [bookmark: pgfId-4152435]Note that you can also delete all local rules on the Rule Updates page. See, for example, Using One-Time Rule Updates.
 
     [bookmark: pgfId-4152444]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4152458]For information on creating custom rules, see Writing New Rules.
 
      	 [bookmark: pgfId-4152557]For information on importing local rules, see Importing Rule Updates and Local Rule Files.
 
      	 [bookmark: pgfId-4152506]For information on setting rule states, see Setting Rule States.
 
     
 
     [bookmark: pgfId-4071699]To delete custom rules:
 
     [bookmark: pgfId-4241266]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4240349]Step 1 Select Policies > Intrusion > Rule Editor.
 
     [bookmark: pgfId-4240350]The Rule Editor page appears.
 
     [bookmark: pgfId-4071706]Step 2 You have two choices:
 
      
       
       	 [bookmark: pgfId-4071789]Click  Delete Local Rules , then click  OK .
 
      
 
     
 
     [bookmark: pgfId-4072151]All rules not currently enabled in an intrusion policy whose changes you have saved are deleted from the local rule category and moved to the deleted category.
 
      
       
       	 [bookmark: pgfId-4071804]Navigate through the folders to the local rule category; click on the local rule category to expand it, then click the delete icon (
 
      
 
      [image: ] ) next to a rule you want to delete. 
     
 
     [bookmark: pgfId-4072001]The rule is deleted from the local rule category and moved to the deleted category.
 
     [bookmark: pgfId-4071710]Note that custom standard text rules have a generator ID (GID) of 1 (for example, 1:1000012) and custom shared object rules have a GID of 3 (for example, 3:1000005).
 
      
       
     
 
     
 
     [bookmark: pgfId-4071725]Tip The system also stores shared object rules that you save with modified header information in the local rule category and lists them with a GID of 3. You can delete your modified version of a shared object rule, but you cannot delete the original shared object rule.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4777066]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2296519][bookmark: 36538]Searching for Rules[bookmark: marker-2296517][bookmark: marker-2296518]
 
    [bookmark: pgfId-4239320]License: Protection
 
    [bookmark: pgfId-2296530]The FireSIGHT System provides thousands of standard text rules, and the Cisco Vulnerability Research Team continues to add rules as new vulnerabilities and exploits are discovered. You can easily search for specific rules so that you can activate, deactivate, or edit them.
 
     
      
       
       [bookmark: pgfId-4917127]Table 36-62 [bookmark: 81792]Rule Search Criteria 
 
       
       
        
        	 
          
          [bookmark: pgfId-4917132] 
          [bookmark: RuleSearchTable]Option 
         
  
        	 
          
          [bookmark: pgfId-4917134]Description 
         
  
       
 
        
        	[bookmark: pgfId-4917136]Signature ID
  
        	[bookmark: pgfId-4917138]To search for a single rule based on Snort ID (also called the Signature ID), enter a Snort ID number. To search for multiple rules, enter a comma-separated list of Snort ID numbers. This field has an 80-character limit.
  
       
 
        
        	[bookmark: pgfId-4917140]Generator ID
  
        	[bookmark: pgfId-4917148]To search for standard text rules, select 1. To search for shared object rules, select 3.
  
       
 
        
        	[bookmark: pgfId-4917150]Message
  
        	[bookmark: pgfId-4917152]To search for a rule with a specific message, enter a single word from the rule message in the Message field. For example, to search for DNS exploits, you would enter DNS, or to search for buffer overflow exploits, enter overflow. 
  
       
 
        
        	[bookmark: pgfId-4917154]Protocol
  
        	[bookmark: pgfId-4917156]To search rules that evaluate traffic of a specific protocol, select the protocol. If you do not select a protocol, search results contain rules for all protocols. 
  
       
 
        
        	[bookmark: pgfId-4917158]Source Port
  
        	[bookmark: pgfId-4917160]To search for rules that inspect packets originating from a specified port, enter a source port number or a port-related variable. 
  
       
 
        
        	[bookmark: pgfId-4917162]Destination Port
  
        	[bookmark: pgfId-4917164]To search for rules that inspect packets destined for a specific port, enter a destination port number or a port-related variable. 
  
       
 
        
        	[bookmark: pgfId-4917166]Source IP
  
        	[bookmark: pgfId-4917168]To search for rules that inspect packets originating from a specified IP address, enter a source IP address or an IP address-related variable. 
  
       
 
        
        	[bookmark: pgfId-4917170]Destination IP
  
        	[bookmark: pgfId-4917172]To search for rules that inspect packets destined for a specified IP address, enter a destination IP address or an IP address-related variable.
  
       
 
        
        	[bookmark: pgfId-4917174]Keyword
  
        	[bookmark: pgfId-4917176]To search for specific keywords, you can use the keyword search options. You select a keyword and a keyword value for which to search. You can also precede the keyword value with an exclamation point (!) to match any value other than the specified value.
  
       
 
        
        	[bookmark: pgfId-4917178]Category
  
        	[bookmark: pgfId-4917180]To search for rules in a specific category, select the category from the Category list. 
  
       
 
        
        	[bookmark: pgfId-4917182]Classification
  
        	[bookmark: pgfId-4917184]To search for rules that have a specific classification, select the classification name from the Classification list.
  
       
 
        
        	[bookmark: pgfId-4917186]Rule State
  
        	[bookmark: pgfId-4917188]To search for rules within a specific policy and a specific rule state, select the policy from the first Rule State list, and choose a state from the second list to search for rules set to Generate Events, Drop and Generate Events, or Disabled.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2127454]To search for specific rules:
 
    [bookmark: pgfId-4241284]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-2127458]Step 1 Select Policies > Intrusion > Rule Editor.
 
    [bookmark: pgfId-2127459]The Rule Editor page appears.
 
    [bookmark: pgfId-2127460]Step 2 Click Search on the toolbar.
 
    [bookmark: pgfId-2127461]The Search page appears.
 
    [bookmark: pgfId-2127468]Step 3 Add search criteria using any of the fields described in the Rule Search Criteria table.
 
     
      
    
 
    
 
    [bookmark: pgfId-4389487]Note You must specify at least one search criterion to search for rules.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4389488]Step 4 Perform the following steps to search for rules that contain specific keywords:
 
     
      
      	 [bookmark: pgfId-2127472]From the drop-down list in the  Keyword section, select the keyword for which to search. 
 
     
 
    
 
    [bookmark: pgfId-2127475]For a list of each available keyword, see Understanding Keywords and Arguments in Rules. 
 
     
      
      	 [bookmark: pgfId-2127477]In the  Keyword field, enter the arguments for which you want to search.
 
     
 
    
 
    [bookmark: pgfId-2127478]Step 5 Click Search.
 
    [bookmark: pgfId-2127479]The page reloads, showing a list of the rules that match your search criteria.
 
    [bookmark: pgfId-2127480]Step 6 To view or edit a rule (or a copy of the rule, if it is a system rule), click the hyperlinked rule message. See Modifying Existing Rules for detailed information about editing rules.
 
    [bookmark: pgfId-4777084]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2894499][bookmark: 41353]Filtering Rules on the Rule Editor P[bookmark: marker-3099259]age
 
    [bookmark: pgfId-4239337]License: Protection
 
    [bookmark: pgfId-2975513]You can filter the rules on the Rule Editor page to display a subset of rules. This can be useful, for example, when you want to modify a rule or change its state but have difficulty finding it among the thousands of rules available.
 
    [bookmark: pgfId-2975517]When you enter a filter, the page displays any folder that includes at least one matching rule, or a message when no rule matches. Your filter can include special keywords and their arguments, character strings, and literal character strings in quotes, with spaces separating multiple filter conditions. A filter cannot include regular expressions, wild card characters, or any special operator such as a negation character (!), a greater than symbol (>), less than symbol (<), and so on.
 
    [bookmark: pgfId-2975639]All keywords, keyword arguments, and character strings are case-insensitive. Except for the gid and sid keywords, all arguments and strings are treated as partial strings. Arguments for gid and sid return only exact matches.
 
    [bookmark: pgfId-2975641]Optionally, you can expand a folder on the original, unfiltered page and the folder remains expanded when the subsequent filter returns matches in that folder. This can be useful when the rule you want to find is in a folder that contains a large number of rules.
 
    [bookmark: pgfId-2982728]You cannot constrain a filter with a subsequent filter. Any filter you enter searches the entire rules database and returns all matching rules. When you enter a filter while the page still displays the result of a previous filter, the page clears and returns the result of the new filter instead.
 
    [bookmark: pgfId-2982729]You can use the same features with rules in a filtered or unfiltered list. For example, you can edit rules in a filtered or unfiltered list on the Rule Editor page. You can also use any of the options in the context menu for the page.
 
    [bookmark: pgfId-2971540]See the following sections for more information:
 
     
     	 [bookmark: pgfId-2971814]Using Keywords in a Rule Filter
 
     	 [bookmark: pgfId-2971865]Using Character Strings in a Rule Filter
 
     	 [bookmark: pgfId-2971899]Combining Keywords and Character Strings in a Rule Filter
 
     	 [bookmark: pgfId-2971912]Filtering Rules
 
    
 
     
      [bookmark: pgfId-2899680][bookmark: 61943]Using Keywor[bookmark: marker-3099260]ds in a Rule Filter
 
     [bookmark: pgfId-4239350]License: Protection
 
     [bookmark: pgfId-2971610]Each rule filter can include one or more keywords in the format:
 
      
      [bookmark: pgfId-2971611]keyword:argument 
     
 
     [bookmark: pgfId-2971615]where keyword is one of the keywords in the Rule Filter Keywords table and argument is a single, case-insensitive, alphanumeric string to search for in the specific field or fields relevant to the keyword.
 
     [bookmark: pgfId-2971616]Arguments for all keywords except gid and sid are treated as partial strings. For example, the argument 123 returns "12345", "41235", "45123", and so on. The arguments for gid and sid return only exact matches; for example, sid:3080 returns only SID 3080.
 
      
       
     
 
     
 
     [bookmark: pgfId-2997592]Tip You can search for a partial SID by filtering with one or more character strings. See Using Character Strings in a Rule Filter for more information.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-2971234]Table 36-63 [bookmark: 60908]Rule Filter Keywords 
 
        
        
         
         	 
           
           [bookmark: pgfId-2971240]Keyword 
          
  
         	 
           
           [bookmark: pgfId-2971242]Description 
          
  
         	 
           
           [bookmark: pgfId-2971244]Example 
          
  
        
 
         
         	[bookmark: pgfId-2971246]arachnids
  
         	[bookmark: pgfId-2971248]Returns one or more rules based on all or part of the Arachnids ID in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971250]arachnids:181
  
        
 
         
         	[bookmark: pgfId-2971252]bugtraq
  
         	[bookmark: pgfId-2971254]Returns one or more rules based on all or part of the Bugtraq ID in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971256]bugtraq:2120
  
        
 
         
         	[bookmark: pgfId-2971258]cve
  
         	[bookmark: pgfId-2971260]Returns one or more rules based on all or part of the CVE number in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971262]cve:2003-0109
  
        
 
         
         	[bookmark: pgfId-2971264]gid
  
         	[bookmark: pgfId-2971266]The argument 1 returns standard text rules. The argument 3 returns shared object rules. See Reading Preprocessor Generator IDs and Table 32-1 for more information.
  
         	[bookmark: pgfId-2971268]gid:3
  
        
 
         
         	[bookmark: pgfId-2971270]mcafee
  
         	[bookmark: pgfId-2971272]Returns one or more rules based on all or part of the McAfee ID in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971274]mcafee:10566
  
        
 
         
         	[bookmark: pgfId-2971276]msg
  
         	[bookmark: pgfId-2971278]Returns one or more rules based on all or part of the rule Message field, also known as the event message. See Defining the Event Message for more information.
  
         	[bookmark: pgfId-2971280]msg:chat
  
        
 
         
         	[bookmark: pgfId-2971282]nessus
  
         	[bookmark: pgfId-2971284]Returns one or more rules based on all or part of the Nessus ID in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971286]nessus:10737
  
        
 
         
         	[bookmark: pgfId-2971288]ref
  
         	[bookmark: pgfId-2971290]Returns one or more rules based on all or part of a single alphanumeric string in a rule reference or in the rule Message field. See Defining the Event Reference and Defining the Event Message for more information.
  
         	[bookmark: pgfId-2971292]ref:MS03-039
  
        
 
         
         	[bookmark: pgfId-2971294]sid
  
         	[bookmark: pgfId-2971296]Returns the rule with the exact Signature ID. See Reading Preprocessor Generator IDs for more information.
  
         	[bookmark: pgfId-2971298]sid:235
  
        
 
         
         	[bookmark: pgfId-2971300]url
  
         	[bookmark: pgfId-2971302]Returns one or more rules based on all or part of the URL in a rule reference. See Defining the Event Reference for more information.
  
         	[bookmark: pgfId-2971304]url:faqs.org
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2976435][bookmark: 82823]Using Character St[bookmark: marker-3099261]rings in a Rule Filter
 
     [bookmark: pgfId-4239363]License: Protection
 
     [bookmark: pgfId-2971683]Each rule filter can include one or more alphanumeric character strings. Character strings search the rule Message field, Signature ID, and Generator ID. For example, the string 123 returns the strings "Lotus123", "123mania", and so on in the rule message, and also returns SID 6123, SID 12375, and so on. For information on the rule Message field, see Defining the Event Message. For information on rule SIDs and GIDs, see Reading Preprocessor Generator IDs. 
 
     [bookmark: pgfId-2971690]All character strings are case-insensitive and are treated as partial strings. For example, any of the strings ADMIN, admin, or Admin return "admin", "CFADMIN", "Administrator" and so on.
 
     [bookmark: pgfId-2971691]You can enclose character strings in quotes to return exact matches. For example, the literal string "overflow attempt" in quotes returns only that exact string, whereas a filter comprised of the two strings overflow and attempt without quotes returns "overflow attempt", "overflow multipacket attempt", "overflow with evasion attempt", and so on.
 
    
 
     
      [bookmark: pgfId-2971375][bookmark: 60128]Combining Keywords and Character Strings in [bookmark: marker-3099262]a Rule Filter
 
     [bookmark: pgfId-4239380]License: Protection
 
     [bookmark: pgfId-2971785]You can narrow filter results by entering any combination of keywords, character strings, or both, separated by spaces. The result includes any rule that matches all the filter conditions.
 
     [bookmark: pgfId-2971788]You can enter multiple filter conditions in any order. For example, each of the following filters returns the same rules:
 
      
      	 [bookmark: pgfId-2971789] url:at login attempt cve:200 
 
      	 [bookmark: pgfId-2971790] login attempt cve:200 url:at 
 
      	 [bookmark: pgfId-2971791] login cve:200 attempt url:at 
 
     
 
    
 
     
      [bookmark: pgfId-4725694][bookmark: 76964]Filtering Ru[bookmark: marker-4725693]les
 
     [bookmark: pgfId-4725698]License: Protection
 
     [bookmark: pgfId-4725699]You can filter the rules on the Rule Editor page to display a subset of rules so you can more easily find specific rules. You can then use any of the page features, including selecting any of the features available in the context menu.
 
     [bookmark: pgfId-2901241]To filter for specific rules:
 
     [bookmark: pgfId-4241302]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-3048309]Step 1 Select Policies > Intrusion > Rule Editor.
 
     [bookmark: pgfId-3048313]The Rule Editor page appears.
 
     [bookmark: pgfId-3048314]Rule filtering can be particularly useful on the Rule Editor page when you want to locate a rule to edit it. See Modifying Existing Rules for more information.
 
     [bookmark: pgfId-3048326]Step 2 Optionally, select a different grouping method from the Group Rules By list.
 
      
       
     
 
     
 
     [bookmark: pgfId-3048327]Tip Filtering may take significantly longer when the combined total of rules in all sub-groups is large because rules appear in multiple categories, even when the total number of unique rules is much smaller.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3048329]Step 3 [bookmark: 68728]Optionally, click the folder next to any group that you want to expand.
 
     [bookmark: pgfId-2950511]The folder expands to show the rules in that group. Note that some rule groups have sub-groups that you can also expand.
 ). 
     
 ) that is inside the text box at the upper left of the rule list. 
     
 
     [bookmark: pgfId-2901461]Step 5 Type your filter constraints and press Enter.
 
     [bookmark: pgfId-2949383]Your filter can include keywords and arguments, character strings with or without quotes, and spaces separating multiple conditions. See Filtering Rules on the Rule Editor Page for more information.
 
     [bookmark: pgfId-2950531]The page refreshes to display any group that contains at least one matching rule.
 
     [bookmark: pgfId-2901481]Step 6 Optionally, open any folder not already opened to display matching rules. You have the following filtering choices:
 
      
       
       	 [bookmark: pgfId-2901482]To enter a new filter, position your cursor inside the filter text box and click to activate it; type your filter and press Enter.
 
       	 [bookmark: pgfId-3023184]To clear the current filtered list and return to the original, unfiltered page, click the filter clearing icon (
 
      
 
      [image: ] ). 
     
 
     [bookmark: pgfId-3023188]Step 7 Optionally, make any changes to the rule that you would normally make on the page. See Modifying Existing Rules.
 
     [bookmark: pgfId-4439062]To put any changes you make into effect, apply the intrusion policy part of an access control policy as described in Applying an Access Control Policy.
 
     [bookmark: pgfId-4777106]
 
      
      
 
     
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1871080][bookmark: 19929]Blocking Mal[bookmark: marker-2040882]ware and Prohibited Files 
      
      
 
     
 
 
    [bookmark: pgfId-2009028]Malicious software, or malware, can enter your organization’s network via multiple routes. To help you identify and mitigate the effects of malware, the FireSIGHT System’s file control, network file trajectory, and advanced malware protection components can detect, track, store, analyze, and optionally block the transmission of malware and other types of files in network traffic. The system can also analyze and act upon nested files inside archive files (such as the archive file formats .zip or .rar).
 
    [bookmark: pgfId-1707030]You configure the system to perform malware protection and file control as part of your overall access control configuration. File policies that you create and associate with access control rules handle network traffic that matches the rules. You can download files detected in that traffic, then submit them to Cisco’s malware awareness network (called the Collective Security Intelligence Cloud) for dynamic analysis[bookmark: marker-2015093] of the file’s signatures to determine whether they contain malware.
 
    [bookmark: pgfId-2009025]The Context Explorer and the dashboard provide you with different types of high-level views of the files (including malware files) detected in your organization’s network traffic. To further target your analysis, you can use a malware file’s network file trajectory page to track the spread of an individual threat across hosts over time, allowing you to concentrate outbreak control and prevention efforts where most useful.
 
    [bookmark: pgfId-2111333]Altho[bookmark: marker-2111332]ugh you can create file policies with any license, certain aspects of malware protection and file control require that you enable specific licensed capabilities on target devices, as described in the following table.
 
    [bookmark: pgfId-2112147]
 
     
      
       
       [bookmark: pgfId-2112076]Table 37-1 License and Appliance Requirements for Intrusion and File Inspection 
 
       
       
        
        	 
          
          [bookmark: pgfId-2112086]Feature 
         
  
        	 
          
          [bookmark: pgfId-2112088]Description 
         
  
        	 
          
          [bookmark: pgfId-2112090]Add this license... 
         
  
        	 
          
          [bookmark: pgfId-2112092]To one of these Defense Centers... 
         
  
        	 
          
          [bookmark: pgfId-2112097]And enable it on one of these devices... 
         
  
       
 
        
        	[bookmark: pgfId-2112099]intrusion prevention
  
        	[bookmark: pgfId-2112101]detect and optionally block intrusions and exploits
  
        	[bookmark: pgfId-2112106]Protection
  
        	[bookmark: pgfId-2112108]Any
  
        	[bookmark: pgfId-2112110]Any
  
       
 
        
        	[bookmark: pgfId-2112112]file control
  
        	[bookmark: pgfId-2112114]detect and optionally block the transmission of file types 
  
        	[bookmark: pgfId-2112119]Protection
  
        	[bookmark: pgfId-2112121]Any
  
        	[bookmark: pgfId-2112123]Any
  
       
 
        
        	[bookmark: pgfId-2112125]advanced malware protection (AMP)
  
        	[bookmark: pgfId-2112127]detect, store, track, and optionally block the transmission of malware
 [bookmark: pgfId-2112131]submit captured files to the Cisco cloud to analyze for malware
  
        	[bookmark: pgfId-2112136]Malware
  
        	[bookmark: pgfId-2112141]Any except DC500
  
        	[bookmark: pgfId-2112146]Any except Series 2 or X-Series
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2112154]If your organization has a FireAMP subscription, the Defense Center can also receive endpoint-based malware detection data from the public Cisco cloud. The Defense Center presents this data alongside any network-based file and malware data generated by the system. Importing FireAMP data does not require a license in addition to your FireAMP subscription. For more information, see Working with Cloud Connections for FireAMP.
 
    [bookmark: pgfId-2111401]For file and malware cloud-based features, you can use a FireAMP Private Cloud instead of the standard cloud connection if your organization requires additional security or wants to limit outside connections. All file and malware cloud lookups, as well as collection and relaying of event data from FireAMP endpoints, are handled through the private cloud; when the private cloud contacts the public Cisco cloud, it does so through an anonymized proxy connection that does not transmit your endpoint event data.
 
    [bookmark: pgfId-2102108]For more information, see:
 
     
     	 [bookmark: pgfId-1601945]Understanding Malware Protection and File Control
 
     	 [bookmark: pgfId-1601949]Understanding and Creating File Policies
 
     	 [bookmark: pgfId-1601953]Working with Cloud Connections for FireAMP
 
    
 
    [bookmark: pgfId-2043761]For more information on evaluating event data related to malware protection and file control, see Analyzing Malware and File Activity.
 
   
 
    
     [bookmark: pgfId-2060264][bookmark: 83805]Understanding Malware Protection and File Control
 
    [bookmark: pgfId-2060846]License: Protection, Malware, or Any
 
    [bookmark: pgfId-2060850]Supported Devices: feature dependent
 
    [bookmark: pgfId-2060854]Supported Defense Centers: feature dependent
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1861792]The system can detect and optionally block malware in many types of files, including PDFs, Microsoft Office documents, and others. Managed devices monitor specific application protocol-based network traffic for transmissions of those file types. When a device detects an eligible file, it can send the file’s SHA-256 hash value to the Defense Center, which then performs a malware cloud lookup[bookmark: marker-1861796] using that information. Based on these results, the Cisco cloud returns a file disposition to the Defense Center. 
 
    [bookmark: pgfId-1964533]When the system detects a file in network traffic, the file storage[bookmark: marker-2014639] feature allows a device to store an eligible file to the hard drive or malware storage pack. For executable files with an Unknown disposition, the device can submit the file for dynamic analysis, regardless of whether the device stores the file. The cloud returns to the Defense Center:
 
     
     	 [bookmark: pgfId-1965918]a threat score that describes the likelihood a file contains malware, and 
 
     	 [bookmark: pgfId-1965922]a dynamic analysis summary report that details why the cloud assigned the threat score. 
 
    
 
    [bookmark: pgfId-1873463]If the file is an eligible executable file, the device can also perform a [bookmark: marker-2014884]Spero analysis of the file structure and submit the resulting Spero signature to the cloud. Using this signature to supplement dynamic analysis, the cloud determines whether the file is malware.
 
    [bookmark: pgfId-2013121]If a file has a disposition in the cloud that you know to be incorrect, you can add the file’s SHA-256 value to a file list:
 
     
     	 [bookmark: pgfId-1965483]To treat a file as if the cloud assigned a clean disposition, add the file to the  clean list [bookmark: marker-2014362].
 
     	 [bookmark: pgfId-1965614]To treat a file as if the cloud assigned a malware disposition, add the file to the  custom detection list. [bookmark: marker-2014367]
 
    
 
    [bookmark: pgfId-1965684]If the system detects a file’s SHA-256 value on a file list, it takes the appropriate action without performing a malware lookup or checking the file disposition. Note that you must configure a rule in the file policy with either a Malware Cloud Lookup or Block Malware action and a matching file type to calculate a file’s SHA value. You can enable use of the clean list or custom detection list on a per-file-policy basis. For more information on managing file lists, see Working with File Lists.
 
    [bookmark: pgfId-2085957]The system can inspect and block nested files inside archive files (such as .zip or .rar archive files) in much the same way as it analyzes and acts upon regular, uncompressed files. Note, however, that if your system blocks any nested file, it blocks the entire archive file that contains it. The system can inspect up to 3 levels of nested files beneath the outermost archive file (which is level 0). You can configure your file policy to block archive files that exceed a specified level of nesting (up to a maximum of 3 levels). 
 
    [bookmark: pgfId-2121645]You can also configure your file policy to block archive files whose contents are encrypted or otherwise unable to be inspected. For more information on archive file inspection, see Configuring Archive File Inspection Options.
 
    [bookmark: pgfId-1884517]To inspect or block files, you must enable a Protection license on the managed devices where you apply policies. To store files, perform malware cloud lookups on and optionally block malware files, submit files to the cloud for dynamic analysis, or add files to a file list, you must also enable a Malware license for those devices.
 
    [bookmark: pgfId-1854330][bookmark: 17858]Understanding File Dis[bookmark: marker-1863054]positions[bookmark: marker-1863099]
 
    [bookmark: pgfId-1789523]The system determines file dispositions based on the disposition returned by the Cisco cloud. A file can have one of the following file dispositions returned by the Cisco cloud, as a result of addition to a file list, or due to threat score:
 
     
     	 [bookmark: pgfId-1789524] Malware indicates that the cloud categorized the file as malware, or that the file’s threat score exceeded the malware threshold defined in the file policy.
 
     	 [bookmark: pgfId-1789525] Clean indicates that the cloud categorized the file as clean, or that a user added the file to the clean list.
 
     	 [bookmark: pgfId-1789526] Unknown indicates that a malware cloud lookup occurred before the cloud assigned a disposition. The cloud has not categorized the file.
 
     	 [bookmark: pgfId-1872434] Custom Detection  indicates that a user added the file to the custom detection list. 
 
     	 [bookmark: pgfId-2115399] Unavailable indicates that the Defense Center could not perform a malware cloud lookup. You may see a small percentage of events with this disposition; this is expected behavior.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2115400]Tip If you see several Unavailable malware events in quick succession, check your cloud connection and port configuration. For more information, see Security, Internet Access, and Communication Ports.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-2128500]Table 37-2 [bookmark: 71890]Archive File Disposition by Contents 
 
       
       
        
        	 
          
          [bookmark: pgfId-2128536]Archive File Disposition 
         
  
        	 
          
          [bookmark: pgfId-2128506]Number of Unknown Files 
         
  
        	 
          
          [bookmark: pgfId-2128508]Number of Clean Files 
         
  
        	 
          
          [bookmark: pgfId-2128510]Number of Malware Files 
         
  
       
 
        
        	[bookmark: pgfId-2128538]Unknown
  
        	[bookmark: pgfId-2128512]1 or more
  
        	[bookmark: pgfId-2128514]Any
  
        	[bookmark: pgfId-2128516]0
  
       
 
        
        	[bookmark: pgfId-2128540]Clean
  
        	[bookmark: pgfId-2128518]0
  
        	[bookmark: pgfId-2128520]1 or more
  
        	[bookmark: pgfId-2128522]0
  
       
 
        
        	[bookmark: pgfId-2128542]Malware
  
        	[bookmark: pgfId-2128524]Any
  
        	[bookmark: pgfId-2128526]Any
  
        	[bookmark: pgfId-2128528]1 or more
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2045213]Based on the file disposition, the Defense Center instructs the managed device either to block the file or to allow its upload or download. Note that if any nested file inside an archive file is blocked, the system blocks the entire archive file. To improve performance, if the system already knows the disposition for a file based on its SHA-256 value, the Defense Center uses the cached disposition rather than querying the Cisco cloud.
 
    [bookmark: pgfId-1842296]Note that file dispositions can change. For example, the cloud can determine that a file that was previously thought to be clean is now identified as malware, or the reverse—that a malware-identified file is actually clean. When the disposition changes for a file for which you performed a malware lookup in the last week, the cloud notifies the Defense Center so the system can take appropriate action the next time it detects that file being transmitted. A changed file disposition is called a retrospective disposition.
 
    [bookmark: pgfId-1846956]File dispositions returned from a malware cloud lookup, and any associated threat scores, [bookmark: marker-1863059]have a time-to-live (TTL) value. After a file disposition has been held for the duration specified in the TTL value without update, the system purges the cached information. Dispositions and associated threat scores have the following TTL values:
 
     
     	 [bookmark: pgfId-1846958]Clean — 4 hours 
 
     	 [bookmark: pgfId-1846959]Unknown — 1 hour
 
     	 [bookmark: pgfId-1846960]Malware — 1 hour
 
    
 
    [bookmark: pgfId-2009044]If a malware cloud lookup against the cache identifies a cached disposition that timed out, the system performs a fresh lookup to determine a file disposition.
 
    [bookmark: pgfId-2009045]Understanding File Control
 
    [bookmark: pgfId-1719962]If your organization wants to block not only the transmission of malware files, but all files of a specific type (regardless of whether the files contain malware), the file control feature allows you to cast a wider net. As with malware protection, managed devices monitor network traffic for transmissions of specific file types, then either block or allow the file. 
 
    [bookmark: pgfId-1842290]File control is supported for all file types where the system can detect malware, plus many additional file types. These file types are grouped into basic categories, including multimedia (swf, mp3), executables (exe, torrent), and PDFs. Note that file control, unlike malware protection, does not require queries of the Cisco cloud.
 
    [bookmark: pgfId-1854505]Using Captured Files, File Events, and Malware Events for Analysis
 
    [bookmark: pgfId-1854462]The system generates malware and file events when files are transferred or blocked. It also collects information on any files captured by a managed device. You can view these events and information using the Defense Center‘s web interface. Additionally, the Context Explorer and the dashboard provide you with different types of high-level views of the files (including malware files) detected by your organization. 
 
    [bookmark: pgfId-2008965]To further target your analysis, the network file trajectory feature allows you to track individual files’ paths of transmission. A file’s trajectory page displays summary information about the file, a graphical map of the file’s transmission from host to host (including blocked transmissions), and a list of the malware or file events associated with the detection or blocking of those files.
 
    [bookmark: pgfId-1780073]Note that because you cannot use a Malware license with a DC500, nor enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to capture or block individual files, submit files for dynamic analysis, or view file trajectories for files for which you conduct a malware cloud lookup.
 
    [bookmark: pgfId-1759517]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1759589]Configuring Malware Protection and File Control
 
     	 [bookmark: pgfId-1759598]Logging Events Based on Malware Protection and File Control
 
     	 [bookmark: pgfId-1759604]Integrating FireAMP with the FireSIGHT System
 
     	 [bookmark: pgfId-1759609]Network-Based AMP vs Endpoint-Based FireAMP
 
     	 [bookmark: pgfId-1759967]Working with Network File Trajectory
 
    
 
     
      [bookmark: pgfId-1719704][bookmark: 91168]Configuring Malware Protection and File Con[bookmark: marker-1774720]trol
 
     [bookmark: pgfId-1771361]License: Protection or Malware
 
     [bookmark: pgfId-1778633]Supported Devices: feature dependent
 
     [bookmark: pgfId-1778651]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1871647]You configure malware protection and file control as part of your overall access control configuration by associating file policies with access control rules. This association ensures that before the system passes a file in traffic that matches an access control rule’s conditions, it first inspects the file. 
 
     [bookmark: pgfId-1966815]A file policy, like its parent access control policy, contains rules that determine how the system handles files that match the conditions of each rule. You can configure separate file rules to take different actions for different file types, application protocols, or directions of transfer.
 
     [bookmark: pgfId-1762618]When a file matches a rule, the rule can:
 
      
      	 [bookmark: pgfId-1966656]allow or block files based on simple file type matching 
 
      	 [bookmark: pgfId-1966657]block files based on malware file disposition 
 
      	 [bookmark: pgfId-1966658]capture files and store them to the device
 
      	 [bookmark: pgfId-1966659]submit captured files for dynamic analysis 
 
     
 
     [bookmark: pgfId-1966795]In addition, the file policy can: 
 
      
      	 [bookmark: pgfId-1966796]automatically treat a file as if it is clean or malware based on entries in the clean list or custom detection list
 
      	 [bookmark: pgfId-1966797]treat a file as if it is malware if the file’s threat score exceeds a configurable threshold
 
      	 [bookmark: pgfId-2127419]inspect the contents of archive files (such as  .zip or  .rar )
 
      	 [bookmark: pgfId-2127420]block archive files whose contents are encrypted, nested beyond a specified maximum archive depth, or otherwise not inspectable
 
     
 
     [bookmark: pgfId-2127421]As a simple example, you could implement a file policy that blocks your users from downloading executable files. As another example, you could examine downloaded PDFs for malware and block any instances you find. For detailed information on file policies and associating them with access control rules, see Understanding and Creating File Policies and Tuning Intrusion Prevention Performance.
 
     [bookmark: pgfId-1780169]Because you cannot use a Malware license with a DC500, you cannot use that appliance to apply file policies that perform network-based malware protection or inspect the contents of archive files. Similarly, because you cannot enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot apply a file policy to those appliances that performs network-based malware protection or inspects the contents of archive files.
 
    
 
     
      [bookmark: pgfId-1722515][bookmark: 31276]Logging Events Based on Malware Protection and File Control
 
     [bookmark: pgfId-1759850]License: Protection or Malware
 
     [bookmark: pgfId-1778717]Supported Devices: feature dependent
 
     [bookmark: pgfId-1871941]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1871945]The Defense Center logs records of the system’s file inspection and handling as captured files, file events, and malware events:
 
      
      	 [bookmark: pgfId-1714150] Captured files represent files that the system captured.
 
      	 [bookmark: pgfId-1985361] File events represent files that the system detected, and optionally blocked, in network traffic.
 
      	 [bookmark: pgfId-1714151] Malware events represent malware files detected, and optionally blocked, in network traffic by the system.
 
      	 [bookmark: pgfId-1714153] Retrospective malware events [bookmark: marker-1714152] represent files whose malware file dispositions have changed.
 
     
 
     [bookmark: pgfId-1722654]Wh[bookmark: marker-1766704]en the system generates a malware event based on detection or blocking of malware in network traffic, it also generates a file event, because to detect malware in a file the system must first detect the file itself. Note that endpoint-based malware events generated by FireAMP Connectors (see Integrating FireAMP with the FireSIGHT System) do not have corresponding file events. Similarly, when the system captures a file in network traffic, it also generates a file event because the system first detected the file.
 
     [bookmark: pgfId-1780472]You can use the Defense Center to view, manipulate, and analyze captured files, file events, and malware events, then communicate your analysis to others. The Context Explorer, dashboards, event viewer, network file trajectory map, and reporting features can give you a deeper understanding of the files and malware detected, captured, and blocked. You can also use events to trigger correlation policy violations, or alert you via email, SMTP, or syslog. For detailed information on file and malware events, see Working with File Events and Working with Malware Events.
 
     [bookmark: pgfId-1778958]Because you cannot use a Malware license with a DC500, nor can you enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to generate or analyze captured files, file events, and malware events associated with malware cloud lookups or with the contents of archive files.
 
    
 
     
      [bookmark: pgfId-1714051][bookmark: 45397]Integra[bookmark: marker-1714120]ting FireAMP with the FireSIGHT System
 
     [bookmark: pgfId-1759663]License: Any
 
     [bookmark: pgfId-1714058]FireAMP is Cisco’s enterprise-class advanced malware analysis and protection solution that discovers, understands, and blocks advanced malware outbreaks, advanced persistent threats, and targeted attacks. 
 
     [bookmark: pgfId-1723812]If your organization has a FireAMP subscription, individual users install FireAMP Connectors[bookmark: marker-1739586] on endpoints: computers and mobile devices. A FireAMP Connector is a lightweight agent that, among other capabilities, can inspect files upon upload, download, execution, open, copy, move, and so on. These connectors communicate with the Cisco cloud to determine if inspected files contain malware. 
 
     [bookmark: pgfId-1750772]When a file is positively identified as malware, the cloud sends the threat identification to the Defense Center. The cloud can also send other kinds of information to the Defense Center, including data on scans, quarantines, blocked executions, and cloud recalls. The Defense Center logs this information as malware events.
 
     [bookmark: pgfId-1847494]With a FireAMP deployment, you can not only configure Defense Center-initiated remediations and alerts based on malware events, but you can also use the FireAMP portal (http://amp.sourcefire.com/) to help you mitigate the effect of malware. The[bookmark: marker-1847499] portal provides a robust, flexible web interface where you control all aspects of your FireAMP deployment and manage all phases of an outbreak. You can:
 
      
      	 [bookmark: pgfId-1847503]configure custom malware detection policies and profiles for your entire organization, as well as perform flash and full scans on all your users’ files
 
      	 [bookmark: pgfId-1724282]perform malware analysis, including view heat maps, detailed file information, network file trajectory, and threat root causes
 
      	 [bookmark: pgfId-1724184]configure multiple aspects of outbreak control, including automatic quarantines, application blocking to stop non-quarantined executables from running, and exclusion lists
 
      	 [bookmark: pgfId-1724367]create custom protections, block execution of certain applications based on group policy, and create custom whitelists
 
     
 
     [bookmark: pgfId-1724076]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1761249]Network-Based AMP vs Endpoint-Based FireAMP compares the malware protection strategies available in the Cisco family of products.
 
      	 [bookmark: pgfId-1761401]Working with Cloud Connections for FireAMP explains how to establish communications between the Defense Center and the Cisco cloud, either directly or via a FireAMP Private Cloud connection. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1772393]Tip For detailed information on FireAMP, refer to the online help on the FireAMP portal.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1772398][bookmark: 51512]Netw[bookmark: marker-1774725]ork-Based AMP vs Endpoint-Based FireAMP
 
     [bookmark: pgfId-1772402]License: Malware or Any
 
     [bookmark: pgfId-1778792]Supported Devices: feature dependent
 
     [bookmark: pgfId-1778793]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1724919]The following diagram shows how you can use the Defense Center to work with data from both a network-based advanced malware protection strategy and an endpoint-based FireAMP strategy.
 
     [bookmark: pgfId-2144630]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1842273]Note that be[bookmark: marker-1842269]cause FireAMP malware detection is performed at the endpoint at download or execution time, while managed devices detect malware in network traffic, the information in the two types of malware events is different. For example, endpoint-based malware events contain information on file path, invoking client application, and so on, while malware detections in network traffic contain port, application protocol, and originating IP address information about the connection used to transmit the file.
 
     [bookmark: pgfId-1750648]As another example, for network-based malware events, user information represents the user most recently logged into the host where the malware was destined, as determined by network discovery. On the other hand, FireAMP-reported users represent the user currently logged into the endpoint where the malware was detected, as determined by the local connector.
 
      
       
     
 
     
 
     [bookmark: pgfId-1780769]Note The IP addresses reported in endpoint-based malware events may not be in your network map—and may not even be in your monitored network. Depending on your deployment, network architecture, level of compliance, and other factors, the endpoints where connectors are installed may not be the same hosts as those monitored by your managed devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2012207]Note that because you cannot use a Malware license with a DC500, nor enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to capture or block individual files, submit files for dynamic analysis, inspect the contents of archive files, or view trajectories of files for which you conduct a malware cloud lookup.
 
     [bookmark: pgfId-2012215]The following table summarizes the differences between the two strategies.
 
     [bookmark: pgfId-1712503]
 
      
       
        
        [bookmark: pgfId-1712405]Table 37-3 Network vs Endpoint-Based Malware Protection Strategies 
 
        
        
         
         	 
           
           [bookmark: pgfId-1712411]Feature 
          
  
         	 
           
           [bookmark: pgfId-1712413]Network-Based 
          
  
         	 
           
           [bookmark: pgfId-1712418]Endpoint-Based (FireAMP) 
          
  
        
 
         
         	[bookmark: pgfId-1712420]file type detection and blocking method (file control)
  
         	[bookmark: pgfId-1712422]in network traffic, using access control and file policies
  
         	[bookmark: pgfId-1712424]not supported
  
        
 
         
         	[bookmark: pgfId-1712426]malware detection and blocking method
  
         	[bookmark: pgfId-1712428]in network traffic, using access control and file policies
  
         	[bookmark: pgfId-1712430]on individual endpoints, using an installed connector that communicates with the Cisco cloud
  
        
 
         
         	[bookmark: pgfId-1712435]network traffic inspected
  
         	[bookmark: pgfId-1712437]traffic passing through a managed device
  
         	[bookmark: pgfId-1712439]none; connectors installed on endpoints directly inspect files
  
        
 
         
         	[bookmark: pgfId-1712441]malware detection robustness
  
         	[bookmark: pgfId-1712443]limited file types
  
         	[bookmark: pgfId-1712445]all file types
  
        
 
         
         	[bookmark: pgfId-1712447]malware analysis choices
  
         	[bookmark: pgfId-1712452]Defense Center-based, plus analysis in the cloud
  
         	[bookmark: pgfId-1712457]Defense Center-based, plus additional options on the FireAMP portal
  
        
 
         
         	[bookmark: pgfId-1712462]malware mitigation
  
         	[bookmark: pgfId-1712467]malware blocking in network traffic, Defense Center-initiated remediations
  
         	[bookmark: pgfId-1712472]FireAMP-based quarantine and outbreak control options, Defense Center-initiated remediations
  
        
 
         
         	[bookmark: pgfId-1712477]events generated
  
         	[bookmark: pgfId-1712479]file events, captured files, malware events, and retrospective malware events
  
         	[bookmark: pgfId-1712481]malware events
  
        
 
         
         	[bookmark: pgfId-1712483]information in malware events
  
         	[bookmark: pgfId-1712485]basic malware event information, plus connection data (IP address, port, and application protocol)
  
         	[bookmark: pgfId-1712487]in-depth malware event information; no connection data
  
        
 
         
         	[bookmark: pgfId-1731409]network file trajectory
  
         	[bookmark: pgfId-1772291]Defense Center-based
  
         	[bookmark: pgfId-1772296]Defense Center-based, plus additional options on the FireAMP portal
  
        
 
         
         	[bookmark: pgfId-1712489]required licenses or subscriptions
  
         	[bookmark: pgfId-1712494]Protection license to perform file control; Malware license to perform malware protection
  
         	[bookmark: pgfId-1712502]FireAMP subscription (not license-based)
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1712507][bookmark: 59582]Understanding and Creating File Policie[bookmark: marker-1712506]s
 
    [bookmark: pgfId-1712514]License: Protection or Malware
 
    [bookmark: pgfId-1778829]Supported Devices: feature dependent
 
    [bookmark: pgfId-1778830]Supported Defense Centers: feature dependent
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1747167]The policy has two access control rules, both of which use the Allow action and are associated with file policies. The policy’s default action is also to allow traffic, but without file policy inspection. In this scenario, traffic is handled as follows:
 
     
     	 [bookmark: pgfId-1747168]Traffic that matches  Rule 1 is inspected by  File Policy A .
 
     	 [bookmark: pgfId-1747169]Traffic that does not match  Rule 1 is evaluated against  Rule 2 . Traffic that matches  Rule 2 is inspected by  File Policy B . 
 
     	 [bookmark: pgfId-1747170]Traffic that does not match either rule is allowed; you cannot associate a file policy with the default action.
 
    
 
    [bookmark: pgfId-1886113]A file policy, like its parent access control policy, contains rules that determine how the system handles files that match the conditions of each rule. You can configure separate file rules to take different actions for different file types, application protocols, or directions of transfer.
 
    [bookmark: pgfId-1966883]Once a file matches a rule, the rule can:
 
     
     	 [bookmark: pgfId-1966884]allow or block files based on simple file type matching 
 
     	 [bookmark: pgfId-1966885]block files based on Malware file disposition 
 
     	 [bookmark: pgfId-1966886]store captured files to the device
 
     	 [bookmark: pgfId-1966887]submit captured files for dynamic analysis 
 
    
 
    [bookmark: pgfId-1966888]In addition, the file policy can: 
 
     
     	 [bookmark: pgfId-1966889]automatically treat a file as if it is clean or malware based on entries in the clean list or custom detection list
 
     	 [bookmark: pgfId-1966890]treat a file as if it is malware if the file’s threat score exceeds a configurable threshold
 
     	 [bookmark: pgfId-2086012]inspect the contents of archive files (such as  .zip or  .rar )
 
     	 [bookmark: pgfId-2086013]block archive files whose contents are encrypted, nested beyond a specified maximum archive depth, or otherwise not inspectable
 
    
 
    [bookmark: pgfId-1758388]You can associate a single file policy with an access control rule whose action is Allow, Interactive Block, or Interactive Block with reset. The system then uses that file policy to inspect network traffic that meets the conditions of the access control rule. By associating different file policies with different access control rules, you have granular control over how you identify and block files transmitted on your network. Note, however, that you cannot use a file policy to inspect traffic handled by the access control default action. For detailed information, see Inspecting Allowed Traffic For Intrusions and Malware.
 
    [bookmark: pgfId-2110472]File R[bookmark: marker-2110471]ules
 
     
      
       
       [bookmark: pgfId-1680277]Table 37-4 File Rule Components 
 
       
       
        
        	 
          
          [bookmark: pgfId-1680281]File Rule Component 
         
  
        	 
          
          [bookmark: pgfId-1680283]Description 
         
  
       
 
        
        	[bookmark: pgfId-1680285]application protocol
  
        	[bookmark: pgfId-1680287]The system can detect and inspect files transmitted via FTP, HTTP, SMTP, IMAP, POP3, and NetBIOS-ssn (SMB). To improve performance, you can restrict file detection to only one of those application protocols on a per-file rule basis.
  
       
 
        
        	[bookmark: pgfId-1680289]direction of transfer
  
        	[bookmark: pgfId-1680291]You can inspect incoming FTP, HTTP, IMAP, POP3, and NetBIOS-ssn (SMB) traffic for downloaded files; you can inspect outgoing FTP, HTTP, SMTP, and NetBIOS-ssn (SMB) traffic for uploaded files.
  
       
 
        
        	[bookmark: pgfId-1680293][bookmark: marker-1697180]file categories and types
  
        	[bookmark: pgfId-1842266]The system can detect various types of files. These file types are grouped into basic categories, including multimedia (swf, mp3), executables (exe, torrent), and PDFs. You can configure file rules that detect individual file types, or on entire categories of file types. 
 [bookmark: pgfId-2145425]For example, you could block all multimedia files, or just ShockWave Flash (swf) files. Or, you could configure the system to alert you when a user downloads a BitTorrent (torrent) file.
 
          
           
         
 
         
 
          
          [bookmark: pgfId-2145689]Caution Adding or removing a file type or file category restarts the Snort process when you apply your changes, temporarily interrupting traffic. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
          How Snort Restarts Affect Traffic for more information. 
           
           
 
          
 
         
 
          
           
         
 
         
 
          
          [bookmark: pgfId-1680297]Caution Frequently triggered file rules can affect system performance. For example, detecting multimedia files in HTTP traffic (YouTube, for example, transmits significant Flash content) could generate an overwhelming number of events. 
           
           
 
          
 
         
  
       
 
        
        	[bookmark: pgfId-1680299]file rule action
  
        	[bookmark: pgfId-1680301]A file rule’s action determines how the system handles traffic that matches the conditions of the rule. 
 [bookmark: pgfId-1680302]Note File rules are evaluated in rule-action, not numerical, order. For more information, see the next section, File Rule Actions and Evaluation Order.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1680305][bookmark: 37584]File Rule Acti[bookmark: marker-1693837]ons and Evaluation Order
 
    [bookmark: pgfId-1716831]Each file rule has an associated action that determines how the system handles traffic that matches the conditions of the rule. You can set separate rules within a file policy to take different actions for different file types, application protocols, or directions of transfer. The rule actions are as follows, in rule-action order:
 
     
     	 [bookmark: pgfId-1694075] Block Files  rules allow you to block specific file types.
 
     	 [bookmark: pgfId-1780942] Block Malware [bookmark: marker-1863138]rules a[bookmark: marker-1863148]llow you to calculate the SHA-256 hash value of specific file types, then use a cloud lookup process to first determine if files traversing your network contain malware, then block files that represent threats.
 
     	 [bookmark: pgfId-1694080] Malware Cloud Lookup [bookmark: marker-1694076] rules allow you to log the malware disposition of files traversing your network based on a cloud lookup, while still allowing their transmission.
 
     	 [bookmark: pgfId-2145325] Detect Files  rules allow you to log the detection of specific file types to the database, while still allowing their transmission.
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-2145326] 
     Caution Changing a file rule action to or from 
     Detect Files or 
     Block Malware, or enabling or disabling 
     Store FIles, restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 
    [bookmark: pgfId-2145330]For each file rule action, you can configure options to reset the connection when a file transfer is blocked, store captured files to the managed device, and submit captured files to the cloud for dynamic and Spero analysis. The following table details the options available to each file action.
 
    [bookmark: pgfId-1860538]
 
     
      
       
       [bookmark: pgfId-2105275]Table 37-5 [bookmark: 54648]File Rule Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-2105285]Action 
         
  
        	 
          
          [bookmark: pgfId-2105287]Resets Connection? 
         
  
        	 
          
          [bookmark: pgfId-2105289]Stores Files? 
         
  
        	 
          
          [bookmark: pgfId-2105291]Dynamic Analysis? 
         
  
        	 
          
          [bookmark: pgfId-2105293]Spero Analysis for MSEXE? 
         
  
       
 
        
        	[bookmark: pgfId-2105295]Block Files
  
        	[bookmark: pgfId-2105297]yes (recommended)
  
        	[bookmark: pgfId-2105299]yes, you can store all matching file types
  
        	[bookmark: pgfId-2105301]no
  
        	[bookmark: pgfId-2105303]no
  
       
 
        
        	[bookmark: pgfId-2105305]Block Malware
  
        	[bookmark: pgfId-2105307]yes (recommended)
  
        	[bookmark: pgfId-2105309]yes, you can store file types matching the file dispositions you select
  
        	[bookmark: pgfId-2105311]yes, you can submit executable files with unknown file dispositions
  
        	[bookmark: pgfId-2105313]yes, you can submit executable files
  
       
 
        
        	[bookmark: pgfId-2105315]Detect Files
  
        	[bookmark: pgfId-2105317]no
  
        	[bookmark: pgfId-2105319]yes, you can store all matching file types
  
        	[bookmark: pgfId-2105321]no
  
        	[bookmark: pgfId-2105323]no
  
       
 
        
        	[bookmark: pgfId-2105325]Malware Cloud Lookup
  
        	[bookmark: pgfId-2105327]no
  
        	[bookmark: pgfId-2105329]yes, you can store file types matching the file dispositions you select
  
        	[bookmark: pgfId-2105331]yes, you can submit executable files with unknown file dispositions
  
        	[bookmark: pgfId-2105333]yes, you can submit executable files
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2009662]File and Malware Detection, Capture, and Blocking Notes and Limitations
 
    [bookmark: pgfId-2009664]Note the following details and limitations on file and malware detection, capture, and blocking behavior:
 
     
     	 [bookmark: pgfId-2009666]If an end-of-file marker is not detected for a file, regardless of transfer protocol, the file will not be blocked by a  Block Malware rule or the custom detection list. The system waits to block the file until the entire file has been received, as indicated by the end-of-file marker, and blocks the file after the marker is detected.
 
     	 [bookmark: pgfId-2009667]If the end-of-file marker for an FTP file transfer is transmitted separately from the final data segment, the marker will be blocked and the FTP client will indicate that the file transfer failed, but the file will actually completely transfer to disk.
 
     	 [bookmark: pgfId-2009668]FTP transfers commands and data over different channels. In a passive or inline tap mode deployment, the traffic from an FTP data session and its control session may not be load-balanced to the same Snort.
 
     	 [bookmark: pgfId-2126629]If a file matches a rule with an application protocol condition, file event generation occurs after the system successfully identifies a file’s application protocol. Unidentified files do not generate file events.
 
     	 [bookmark: pgfId-2102971]For an access control policy using a file policy with  Block Malware rules for FTP, if you set the default action to an intrusion policy with  Drop when Inline disabled, the system generates events for detected files or malware matching the rules, but does not drop the files. To block FTP fire transfers and use an intrusion policy as the default action for the access control policy where you select the file policy, you must select an intrusion policy with  Drop when Inline enabled.
 
     	 [bookmark: pgfId-2102972]File rules with  Block Files and  Block Malware actions block automatic resumption of file download via HTTP by blocking new sessions with the same file, URL, server, and client application detected for 24 hours after the initial file transfer attempt occurs.
 
     	 [bookmark: pgfId-2009671]In rare cases, if traffic from an HTTP upload session is out of order, the system cannot reassemble the traffic correctly and therefore will not block it or generate a file event. 
 
     	 [bookmark: pgfId-2009672]If you transfer a file over NetBIOS-ssn (such as an SMB file transfer) that is blocked with a  Block Files rule, you may see a file on the destination host. However, the file is unusable because it is blocked after the download starts, resulting in an incomplete file transfer.
 
     	 [bookmark: pgfId-2102815]If you create file rules to detect or block files transferred over NetBIOS-ssn (such as an SMB file transfer), the system does not inspect files transferred in an established TCP or SMB session started before you apply an access control policy invoking the file policy so those files will not be detected or blocked.
 
     	 [bookmark: pgfId-2102816]A rule configured to block files in a passive deployment does not block matching files. Because the connection continues to transmit the file, if you configure the rule to log the beginning of the connection, you may see multiple events logged for this connection.
 
     	 [bookmark: pgfId-2102817]If the total number of bytes for all file names for files in a POP3, POP, SMTP, or IMAP session exceeds 1024, file events from the session may not reflect the correct file names for files that were detected after the file name buffer filled. 
 
     	 [bookmark: pgfId-2012038]When transmitting text-based files over SMTP, some mail clients convert newlines to the CRLF newline character standard. Since Mac-based hosts use the carriage return (CR) character and Unix/Linux-based hosts use the line feed (LF) character, newline conversion by the mail client can modify the size of the file. Note that some mail clients default to newline conversion when processing an unrecognizable file type.
 
     	 [bookmark: pgfId-2009675]Cisco recommends that you enable  Reset Connection for the  Block Files and  Block Malware actions to prevent blocked application sessions from remaining open until the TCP connection resets. If you do not reset connections, the client session will remain open until the TCP connection resets itself.
 
     	 [bookmark: pgfId-2009676]If a file rule is configured with a  Malware Cloud Lookup or  Block Malware action and the Defense Center cannot establish connectivity with the cloud, the system cannot perform any configured rule action options until cloud connectivity is restored.
 
     	 [bookmark: pgfId-2137354]If you are monitoring high volumes of traffic, do  not store all captured files, or submit all captured files for dynamic analysis. Doing so can negatively impact system performance. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2137355]Note Until a file is detected and blocked in a session, packets from the session may be subject to intrusion inspection.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2137356]File Rule Evaluation Example
 
     
      
       
       [bookmark: pgfId-1936747]Table 37-6 File Rule Evaluation Order Example 
 
       
       
        
        	 
          
          [bookmark: pgfId-1936757]App. Protocol 
         
  
        	 
          
          [bookmark: pgfId-1936759]Direction 
         
  
        	 
          
          [bookmark: pgfId-1936761]Action 
         
  
        	 
          
          [bookmark: pgfId-1936763]Action Options 
         
  
        	 
          
          [bookmark: pgfId-1936765]Result 
         
  
       
 
        
        	[bookmark: pgfId-1936767]SMTP
  
        	[bookmark: pgfId-1936769]Upload
  
        	[bookmark: pgfId-1936771]Block Files
  
        	[bookmark: pgfId-1936773]Reset Connection
  
        	[bookmark: pgfId-1936775]Blocks users from emailing PDF files and resets the connection.
  
       
 
        
        	[bookmark: pgfId-1936777]FTP
  
        	[bookmark: pgfId-1936779]Download
  
        	[bookmark: pgfId-1936781]Block Malware
  
        	[bookmark: pgfId-1936783]Store Files with Unknown Disposition, Reset Connection
  
        	[bookmark: pgfId-1936785]Blocks the download of malware PDF files via file transfer, stores files with an Unknown file disposition to the device, and resets the connection.
  
       
 
        
        	[bookmark: pgfId-1936787]POP3
 [bookmark: pgfId-2105384]IMAP
  
        	[bookmark: pgfId-1936789]Download
  
        	[bookmark: pgfId-1936791]Malware Cloud Lookup
  
        	[bookmark: pgfId-1936793]Store Files with Unknown Disposition, Dynamic Analysis
  
        	[bookmark: pgfId-1936795]Inspects PDF files received via email for malware, and stores files with an Unknown file disposition to the device. Submits the files to the Cisco cloud for dynamic analysis.
  
       
 
        
        	[bookmark: pgfId-1936800]Any
  
        	[bookmark: pgfId-1936802]Any
  
        	[bookmark: pgfId-1936804]Detect Files
  
        	[bookmark: pgfId-1936806]none
  
        	[bookmark: pgfId-1936808]Detects and logs, but allows the traffic, when users view PDF files on the web (that is, via HTTP).
  
       
 
       
     
 
    
 ) to designate conflicting file rules. For details, hover your pointer over a warning icon. 
    
 
    [bookmark: pgfId-1850781]Note that you cannot perform malware analysis on all file types detected by the system. After you select values from the Application Protocol, Direction of Transfer, and Action drop-down lists, the system constrains the list of file types.
 
    [bookmark: pgfId-1851057]Note that because you cannot use a Malware license with a DC500, you cannot create file rules that use the Block Malware or Malware Cloud Lookup action or use that appliance to apply file policies that contain rules with those actions. Similarly, because you cannot enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot apply a file policy containing rules with those actions to those appliances.
 
    [bookmark: pgfId-1602169][bookmark: marker-2014686]Logging Captured Files, File Events, [bookmark: marker-1693842]Malware Events and Alerts
 
    [bookmark: pgfId-1716837]When you associate a file policy with an access control rule, the system automatically enables file and malware event logging for matching traffic. If the file policy is configured to capture and store files, the system also automatically enables captured file logging when a file is captured. When the system inspects a file, it can generate the following types of events:
 
     
     	 [bookmark: pgfId-1674725] file events , which represent detected or blocked files, and detected malware files
 
     	 [bookmark: pgfId-1694231] malware events , which represent detected malware files
 
     	 [bookmark: pgfId-1694233] retrospective malware events [bookmark: marker-1694232], which are generated when the Malware file disposition for a previously detected file changes
 
    
 
    [bookmark: pgfId-1674651]When a file policy generates a file or malware event, or captures a file, the system automatically logs the end of the associated connection to the Defense Center database, regardless of the logging configuration of the invoking access control rule. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1868720]Note File events generated by inspecting NetBIOS-ssn (SMB) traffic do not immediately generate connection events because the client and server establish a persistent connection. The system generates connection events after the client or server ends the session.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1868207]For each of these connection events:
 
     
     	 [bookmark: pgfId-1674658]The  Files field contains an icon (
 
     [image: ] ) that indicates the number of files (including malware files) detected in the connection; click the icon to see a list of those files and, for malware files, their file dispositions. 
    
 
     
     	 [bookmark: pgfId-1854191]The  Reason field indicates the reason the connection event was logged, which depends on the file rule action: 
 
      
      	 [bookmark: pgfId-1860605] File Monitor for Detect Files and Malware Cloud Loo[bookmark: marker-1854192]kup file rules and for files on the clean list
 
      	 [bookmark: pgfId-1860619] File Block for B[bookmark: marker-1863184]lock Files or Block Malware file rules
 
      	 [bookmark: pgfId-1876396] File Custom Detection if the system encountered a file on the custom detection list
 
      	 [bookmark: pgfId-1863194] File Resume Allow where file transmission was originally blocked by a Block Files or Block Malware file rule. After a new access control policy was applied that allowed the file, the HTTP session automatically resumed.
 
      	 [bookmark: pgfId-1931869] File Resume Block where file transmission was originally allowed by a Detect Files or Malware Cloud Lookup file rule. After a new access control policy was applied that blocked the file, the HTTP session automatically stopped.
 
     
 
     	 [bookmark: pgfId-1854193]For connections where a file or malware was blocked, the  Action is  Block. 
 
    
 
    [bookmark: pgfId-1781852]As with any kind of event generated by the FireSIGHT System, you can view, manipulate, and analyze file and malware events using the Defense Center’s web interface. You can also use malware events to trigger correlation policy violations, or alert you via email, SMTP, or syslog.
 
     
      
    
 
    
 
    [bookmark: pgfId-1842253]Note The Defense Center can also receive [bookmark: marker-1842252]malware events using your organization’s FireAMP subscription. Because these malware events are generated on endpoints at download or execution time, their information is different from that in network-based malware events.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1674575]For more information on connection, file, and malware events, as well as additional details on how they are logged, see:
 
     
     	 [bookmark: pgfId-1609192]Logging Connections in Network Traffic
 
     	 [bookmark: pgfId-1609203]Working with File Events
 
     	 [bookmark: pgfId-1609205]Working with Malware Events
 
     	 [bookmark: pgfId-1609245]Understanding Connection and Security Intelligence Data
 
    
 
    [bookmark: pgfId-1602195]Internet Access and High Availability
 
    [bookmark: pgfId-2099781]The s[bookmark: marker-1853582]ystem uses port 443 to perform malware cloud lookups for network-based AMP. You must open that port outbound on the Defense Center. 
 
    [bookmark: pgfId-2099794]Although they share file policies and related configurations, Defense Centers in a high availability pair share neither cloud connections nor captured files, file events, and malware events. To ensure continuity of operations, and to ensure that detected files’ malware dispositions are the same on both Defense Centers, both primary and secondary Defense Centers must have access to the cloud.
 
    [bookmark: pgfId-2018430]To submit files to the cloud for dynamic analysis, you must also open port 443 outbound on the device.
 
     
      
    
 
    
 
    [bookmark: pgfId-2099923]Note Note that the FireAMP Private Cloud requires the same open ports and has the same high availability limitations as the public Cisco cloud connection.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1606605]Managing Fi[bookmark: marker-1697316]le Policies
 
    [bookmark: pgfId-1606606]You create, edit, delete, and compare file policies on the File Policies page (Policies > Files), which displays a list of existing file policies along with their last-modified dates. 
 ) for a file policy displays a dialog box that tells you which access control policies use the file policy, then redirects you to the Access Control Policy page. This is because you cannot apply a file policy independently, as a file policy is considered part of its parent access control policies. To use a new file policy, or to apply changes made to an existing file policy, you must apply or reapply the parent access control policies. 
    
 
    [bookmark: pgfId-1929649]Note the following:
 
     
     	 [bookmark: pgfId-1928800]The system checks the cloud for updates to the list of file types eligible for dynamic analysis (no more than once a day). If the list of eligible file types changes, this constitutes a change in the file policy; any access control policy using the file policy is marked out-of-date if applied to any devices. You must reapply the parent access control policy to apply the updated file policy to the device.
 
     	 [bookmark: pgfId-1610586]You cannot delete a file policy used in a saved or applied access control policy. 
 
    
 
    [bookmark: pgfId-1606831]For more information on managing file policies, see the following sections:
 
     
     	 [bookmark: pgfId-1602229]Creating a File Policy
 
     	 [bookmark: pgfId-1602233]Working with File Rules
 
     	 [bookmark: pgfId-1602241]Comparing Two File Policies
 
    
 
     
      [bookmark: pgfId-1602243][bookmark: 35719]Creating a File P[bookmark: marker-1697321]olicy
 
     [bookmark: pgfId-1779116]License: Protection or Malware
 
     [bookmark: pgfId-1782777]Supported Devices: feature dependent
 
     [bookmark: pgfId-1782779]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1863217]After you create a file policy and populate it with rules, you can use it in an access control policy. 
 
     [bookmark: pgfId-1969363]Note that because you cannot use a Malware license with a DC500, you cannot create file rules that use the Block Malware or Malware Cloud Lookup action or use that appliance to apply file policies that contain rules with those actions. Similarly, because you cannot enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot apply a file policy containing rules with those actions to those appliances.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1602250]To create a file policy:
 
    [bookmark: pgfId-1602251]Access: Admin/Access Admin
 
    
 
    [bookmark: pgfId-1602252]Step 1 Select Policies > Files.
 
    [bookmark: pgfId-1602253]The File Policies page appears.
 
    [bookmark: pgfId-1602254]Step 2 Click New File Policy.
 
    [bookmark: pgfId-1602255]The New File Policy dialog box appears.
 
    [bookmark: pgfId-1611922]For a new policy, the web interface indicates that the policy is not in use. If you are editing an in-use file policy, the web interface tells you how many access control policies use the file policy. In either case, you can click the text to jump to the Access Control Policies page; see Getting Started with Access Control Policies.
 
    [bookmark: pgfId-1611916]Step 3 Enter a Name and optional Description for your new policy, then click Save.
 
    [bookmark: pgfId-1611917]The File Policy Rules tab appears.
 
    [bookmark: pgfId-1611839]Step 4 Add one or more rules to the file policy.
 
    [bookmark: pgfId-1611840]File rules give you granular control over which file types you want to log, block, or scan for malware. For information on adding file rules, see Working with File Rules.
 
    [bookmark: pgfId-1851032]Because you cannot use a Malware license with a DC500, you cannot create file rules that use the Block Malware or Malware Cloud Lookup action or use that appliance to apply file policies that contain rules with those actions. Similarly, because you cannot enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot apply a file policy containing rules with those actions to those appliances.
 
    [bookmark: pgfId-1968001]Step 5 Configure the advanced options. See Configuring Advanced File Policy General Options and Configuring Archive File Inspection Options for more information.
 
    [bookmark: pgfId-1848671]Step 6 Click Save.
 
    [bookmark: pgfId-1602268]To use your new policy, you must add the file policy to an access control rule, then apply the access control policy. If you are editing an existing file policy, you must reapply any access control policies that use the file policy.
 
    [bookmark: pgfId-2074048]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1602270][bookmark: 23561]Working [bookmark: marker-1697341]with File Rules
 
    [bookmark: pgfId-1602271]License: Protection or Malware
 
    [bookmark: pgfId-1782850]Supported Devices: feature dependent
 
    [bookmark: pgfId-1782851]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1716877]To be effective, a file policy must contain one or more rules. You create, edit, and delete rules on the File Policy Rules page, which appears when you create a new file policy or edit an existing policy. The page lists all the rules in the policy, along with each rule’s basic characteristics. 
 
    [bookmark: pgfId-1642958]The page also notifies you of how many access control policies use this file policy. You can click the notification to display a list of the parent policies and, optionally, continue to the Access Control Policies page.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-2145262] 
     Caution Adding or removing a file type or file category, changing a file rule action to or from 
     Detect Files or 
     Block Malware, or enabling or disabling 
     Store FIles, restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1642943]To create a file rule:
 
    [bookmark: pgfId-1642944]Access: Admin/Access Admin
 
    
 
    [bookmark: pgfId-1602275]Step 1 Select Policies > Files.
 
    [bookmark: pgfId-1602276]The File Policies page appears.
 
    [bookmark: pgfId-1602277]Step 2 You have the following options:
 
     
      
      	 [bookmark: pgfId-1602278]To add rules to a new policy, click  New File Policy to create a new policy; see Creating a File Policy.
 
      	 [bookmark: pgfId-1602282]To add rules to an existing policy, click the edit icon (
 
     
 
     [image: ] ) next to the policy. 
    
 
    [bookmark: pgfId-1602283]Step 3 On the File Policy Rules page that appears, click Add File Rule.
 
    [bookmark: pgfId-1602284]The Add File Rule dialog box appears.
 
    [bookmark: pgfId-1831739]Step 4 Select an Application Protocol.
 
    [bookmark: pgfId-1831740]Any, the default, detects files in HTTP, SMTP, IMAP, POP3, FTP, and NetBIOS-ssn (SMB) traffic.
 
    [bookmark: pgfId-1603907]Step 5 Select a Direction of Transfer.
 
    [bookmark: pgfId-1829561]You can inspect the following types of incoming traffic for downloaded files:
 
     
      
      	 [bookmark: pgfId-1975202]HTTP
 
      	 [bookmark: pgfId-1975149]IMAP
 
      	 [bookmark: pgfId-1975152]POP3
 
      	 [bookmark: pgfId-1975155]FTP
 
      	 [bookmark: pgfId-1975159]NetBIOS-ssn (SMB)
 
     
 
    
 
    [bookmark: pgfId-1975059]You can inspect the following types of outgoing traffic for uploaded files:
 
     
      
      	 [bookmark: pgfId-1975181]HTTP
 
      	 [bookmark: pgfId-1975184]FTP 
 
      	 [bookmark: pgfId-1975187]SMTP 
 
      	 [bookmark: pgfId-1975190]NetBIOS-ssn (SMB)
 
     
 
    
 
    [bookmark: pgfId-1975143]Use Any to detect files over multiple application protocols, regardless of whether users are sending or receiving.
 
    [bookmark: pgfId-2146049]Step 6 Select a file rule Action. See the File Rule Actions table for more information. 
 
    [bookmark: pgfId-2146054]When you select either Block Files or Block Malware, Reset Connection is enabled by default. To not reset the connection where a blocked file transfer occurs, clear the option.
 
     
      
    
 
    
 
    [bookmark: pgfId-2006654]Note Cisco recommends that you leave Reset Connection enabled to prevent blocked application sessions from remaining open until the TCP connection resets.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1602295]For detailed information on file rule actions, see File Rule Actions and Evaluation Order.
 
    [bookmark: pgfId-1835221]Note that because you cannot use a Malware license with a DC500, you cannot create file rules that use the Block Malware or Malware Cloud Lookup action or use that appliance to apply file policies that contain rules with those actions. Similarly, because you cannot enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot apply a file policy containing rules with those actions to those appliances.
 
    [bookmark: pgfId-1850717]Step 7 Select one or more File Types. Use the Shift and Ctrl keys to select multiple file types. You can filter the list of file types in the following ways:
 
     
      
      	 [bookmark: pgfId-1602298]Select one or more  File Type Categories .
 
      	 [bookmark: pgfId-1602299]Search for a file type by its name or description. For example, type  Windows in the  Search name and description field to display a list of Microsoft Windows-specific files.
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1676480]Tip Hover your pointer over a file type to view its description.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1832839]The file types that you can use in a file rule vary depending on your selections for Application Protocol, Direction of Transfer, and Action. 
 
    [bookmark: pgfId-1832840]For example, selecting Download as the Direction of Transfer removes GIF, PNG, JPEG, TIFF, and ICO from the Graphics category to prevent an excess of file events. 
 
    [bookmark: pgfId-1676481]Step 8 Add the selected file types to the Selected Files Categories and Types list:
 
     
      
      	 [bookmark: pgfId-1676482]Click  Add to add selected file types to the rule.
 
      	 [bookmark: pgfId-1676463]Drag and drop one or more file types into the  Selected Files Categories and Types list.
 
      	 [bookmark: pgfId-1855882]With a category selected, click  All types in selected Categories , then either click  Add or drag and drop that selection to the  Selected Files Categories and Types list.
 
     
 
    
 
    [bookmark: pgfId-1602305]Step 9 Click Save.
 
    [bookmark: pgfId-1829964]The file rule is added to the policy. If you are editing an existing file policy, you must reapply any access control policies that use the file policy for your changes to take effect.
 
    [bookmark: pgfId-2074079]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1969270][bookmark: 50520]Configuring Advanced File Policy General Options
 
    [bookmark: pgfId-1969529]License: Malware
 
    [bookmark: pgfId-1969530]Supported Devices: feature dependent
 
    [bookmark: pgfId-1969531]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1969911]In a file policy, you can set the following advanced options in the General section. For information on advanced Archive File Inspection options, see Configuring Archive File Inspection Options.
 
    [bookmark: pgfId-1969912]
 
     
      
       
       [bookmark: pgfId-2105438]Table 37-7 [bookmark: 91200]Advanced File Policy General Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-2105444]Field 
         
  
        	 
          
          [bookmark: pgfId-2105446]Description 
         
  
        	 
          
          [bookmark: pgfId-2105448]Default Value 
         
  
       
 
        
        	[bookmark: pgfId-2105450]Enable Custom Detection List
  
        	[bookmark: pgfId-2105452]Select this to block files on the custom detection list when detected. 
  
        	[bookmark: pgfId-2105454]enabled
  
       
 
        
        	[bookmark: pgfId-2105456]Enable Clean List
  
        	[bookmark: pgfId-2105458]Select this to allow files on the clean list when detected. 
  
        	[bookmark: pgfId-2105460]enabled
  
       
 
        
        	[bookmark: pgfId-2105462]Mark files as malware based on dynamic analysis threat score
  
        	[bookmark: pgfId-2105464]Select a threshold value to automatically treat files with that threat score or higher as if they are malware. Select Disabled to disable this.
 [bookmark: pgfId-2105465]Note that as you select lower threshold values, you increase the number of files treated as malware. Depending on the action selected in your file policy, this can result in an increase of blocked files.
  
        	[bookmark: pgfId-2105467]Very High
(76 and above)
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1969558]Note that because you cannot use a Malware license with a DC500, you cannot use or modify these settings. Similarly, because you cannot enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot apply a file policy with these settings enabled.
 
    [bookmark: pgfId-1969370]To configure advanced file policy general options:
 
    [bookmark: pgfId-1973722]Access: Admin/Access Admin
 
    
 
    [bookmark: pgfId-1973723]Step 1 Select Policies > Files.
 
    [bookmark: pgfId-1973724]The File Policies page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1973809]The File Policy Rule page appears. 
 
    [bookmark: pgfId-1969271]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-1969272]The Advanced tab appears.
 
    [bookmark: pgfId-1969292]Step 4 In the General section, modify the options as described in the Advanced File Policy General Options table.
 
    [bookmark: pgfId-1974035]Step 5 Click Save.
 
    [bookmark: pgfId-1974036]You must reapply any access control policies that use the file policy you edited.
 
    [bookmark: pgfId-2074119]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2086078][bookmark: 28528]Configuring Archive File Inspection Options
 
    [bookmark: pgfId-2086088]License: Malware
 
    [bookmark: pgfId-2086095]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-2086102]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-2086103]Archive files (such as .zip or .rar) often appear in monitored traffic. Some are just a convenient way to compress and transfer legitimate information; others may try to conceal malware or other undesirable files. You can configure your file policy to inspect the contents of archive files, allowing you to analyze and, optionally, block archive files according to your organization’s needs. All features applicable to uncompressed files (such as dynamic analysis and file storage) are available for nested files inside archive files. You can view the contents of an archive file from the event viewer or file trajectory viewer using the context menu; for more information, see the following section, Viewing the Contents of Archived Files.
 
     
      
    
 
    
 
    [bookmark: pgfId-2086107]Note If traffic that contains an archive file is blacklisted or whitelisted by Security Intelligence, or if the top-level archive file’s SHA-256 value is on the custom detection list, the system does not inspect the contents of the archive file. If a nested file is blacklisted, the entire archive is blocked; however, if a nested file is whitelisted, the archive is not automatically passed (depending on any other nested files and characteristics). For more information, see Working with the Global Whitelist and Blacklist.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2086111]Some archive files contain additional archive files (and so on). The level at which a file is nested is its archive file depth. Note that the top-level archive file is not considered in the depth count; depth begins at 1 with the first nested file. Although the system can only inspect up to 3 levels of nested archive files, you can configure your file policy to block archive files that exceed that depth (or a lower maximum depth that you specify). If you want to restrict nested archives further, you have the option to configure a lower maximum file depth of 2 or 1. If you choose not to block files that exceed the maximum archive file depth of 3, when archive files that contain some extractable contents and some contents nested at a depth of 3 or greater appear in monitored traffic, the system examines and reports data only for the files it was able to inspect.
 
    [bookmark: pgfId-2086112]Archive files receive file dispositions based on the dispositions of the files they contain. All archives that contain identified malware files receive a disposition of Malware. Archives without identified malware files receive a disposition of Unknown if they contain any unknown files, and a disposition of Clean if they contain only clean files. For more information about file dispositions, see Understanding File Dispositions.
 
     
      
       
       [bookmark: pgfId-2105700]Table 37-8 [bookmark: 27700]Archive File Inspection Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-2105706]Field 
         
  
        	 
          
          [bookmark: pgfId-2105708]Description 
         
  
        	 
          
          [bookmark: pgfId-2105710]Default Value 
         
  
       
 
        
        	[bookmark: pgfId-2105712]Inspect Archives
  
        	[bookmark: pgfId-2105714]Select this to inspect the contents of archive files. If this option is unselected, the options below are grayed out and unavailable.
 
          
           
         
 
         
 
          
          [bookmark: pgfId-2140061]Caution Enabling or disabling archive file inspection restarts the Snort process when you apply your changes, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
          How Snort Restarts Affect Traffic for more information. 
           
           
 
          
 
         
  
        	[bookmark: pgfId-2105716]Disabled
  
       
 
        
        	[bookmark: pgfId-2105718]Block Encrypted Archives
  
        	[bookmark: pgfId-2105720]Select this to block archive files that have encrypted contents.
  
        	[bookmark: pgfId-2105722]Disabled
  
       
 
        
        	[bookmark: pgfId-2105724]Block Uninspectable Archives
  
        	[bookmark: pgfId-2105726]Select this to block archive files with contents that the system is unable to inspect for reasons other than encryption (this usually applies to files corrupted in some way, or those that exceed your specified maximum archive depth).
  
        	[bookmark: pgfId-2105728]Enabled
  
       
 
        
        	[bookmark: pgfId-2105730]Max Archive Depth
  
        	[bookmark: pgfId-2105732]Specify the maximum depth of nested archive files. Archive files that exceed this depth are blocked. The value must be 1, 2, or 3. The top-level archive file is not considered in this count; depth begins at 1 with the first nested file.
  
        	[bookmark: pgfId-2105734]2
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2086158]To configure archive file inspection options:
 
    [bookmark: pgfId-2086162]Access: Admin/Access Admin
 
    
 
    [bookmark: pgfId-2086163]Step 1 Select Policies > Files.
 
    [bookmark: pgfId-2086164]The File Policies page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-2086169]The File Policy Rule page appears.
 
    [bookmark: pgfId-2086170]Step 3 Select the Advanced tab.
 
    [bookmark: pgfId-2086171]The Advanced tab appears.
 
    [bookmark: pgfId-2086174]Step 4 In the Archive File Inspection section, modify the options as described in the Archive File Inspection Options.
 
    [bookmark: pgfId-2086176]Step 5 Click Save.
 
    [bookmark: pgfId-2086177]You must reapply any access control policies that use the file policy you edited.
 
    [bookmark: pgfId-2086178]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2086180][bookmark: 94039]Viewing the Contents of Archived Files
 
    [bookmark: pgfId-2086190]License: Malware
 
    [bookmark: pgfId-2086197]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-2086204]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-2086205]If your file policy is configured to inspect archive file contents, you can use the event viewer context menu and the network file trajectory viewer to view information about the files inside an archive when the archive file appears in a file event, malware event, or as a captured file. 
 
    [bookmark: pgfId-2086206]For more information, see:
 
     
     	 [bookmark: pgfId-2086210]Using the Context Menu
 
     	 [bookmark: pgfId-2086214]Viewing File Events
 
     	 [bookmark: pgfId-2086218]Viewing Malware Events
 
     	 [bookmark: pgfId-2086222]Viewing Captured Files
 
     	 [bookmark: pgfId-2086226]Reviewing Network File Trajectory
 
    
 . In each case, the window that appears is the same. The following graphic is an example of an Archive Contents window. 
    
 
    [bookmark: pgfId-2144678]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-2054095]All file contents of the archive are listed in table form, with a short summary of their relevant information: name, SHA-256 hash value, type, category, and archive depth. A network file trajectory icon appears by each file, which you can click to view further information about that specific file with the Network Trajectory feature.
 
    [bookmark: pgfId-2086260]To view the contents of an archived file from the event viewer:
 
    [bookmark: pgfId-2086264]Access: Admin/Access Admin
 
    
 
    [bookmark: pgfId-2086265]Step 1 Navigate to your chosen event viewer. You have three options:
 
     
      
      	 [bookmark: pgfId-2086266]For malware events, select  Analysis > Files > Malware Events .
 
      	 [bookmark: pgfId-2086267]For file events, select  Analysis > Files> File Events .
 
      	 [bookmark: pgfId-2086268]For captured files, select  Analysis > Files > Captured Files .
 
     
 
    
 
    [bookmark: pgfId-2086269]The first page of your default events workflow appears.
 
    [bookmark: pgfId-2086270]Step 2 Right-click the table row in which the archive file you want to examine appears.
 
    [bookmark: pgfId-2086271]The context menu appears.
 
    [bookmark: pgfId-2086272]Step 3 From the context menu, click View Archive Contents.
 
    [bookmark: pgfId-2086273]The Archive Contents window appears.
 
    [bookmark: pgfId-2086274]To view the contents of an archived file from the file trajectory viewer:
 
    [bookmark: pgfId-2086278]Access: Admin/Access Admin
 
    
 
    [bookmark: pgfId-2086279]Step 1 Select Analysis > Files > Network File Trajectory.
 
    [bookmark: pgfId-2086280]The Network File Trajectory List page appears.
 ) for the archive file you want to examine. 
    
 
    [bookmark: pgfId-2086282]The file trajectory page for that file appears.
 ). 
    
 
    [bookmark: pgfId-2086287]The Archive Contents window appears.
 
    [bookmark: pgfId-2086288]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1829969][bookmark: 24804]Comparing Two Fi[bookmark: marker-1829968]le Policies
 
    [bookmark: pgfId-1602315]License: Protection
 
    [bookmark: pgfId-1622148]To review policy changes for compliance with your organization’s standards or to optimize system performance, you can examine the differences between any two file policies, or two revisions of the same policy. 
 
    [bookmark: pgfId-1842238]The file policy comparison view displays two file policies or revisions in a side-by-side format, with the time of last modification and the last user to modify displayed next to each policy name. Differences between the two policies are highlighted:
 
     
     	 [bookmark: pgfId-1602323]Blue indicates that the highlighted setting is different in the two policies, and the difference is noted in red text. 
 
     	 [bookmark: pgfId-1602324]Green indicates that the highlighted setting appears in one policy but not the other.
 
    
 , which is a PDF version of the comparison view. 
    
 
    [bookmark: pgfId-1602333]To compare two file policies:
 
    [bookmark: pgfId-1602334]Access: Admin/Access Admin
 
    
 
    [bookmark: pgfId-1602335]Step 1 Select Policies > Files.
 
    [bookmark: pgfId-1602336]The File Policies page appears.
 
    [bookmark: pgfId-1602337]Step 2 Click Compare Policies.
 
    [bookmark: pgfId-1602338]The Select Comparison dialog box appears.
 
    [bookmark: pgfId-1602343]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make:
 
     
      
      	 [bookmark: pgfId-1602344]To compare two different policies, select either  Running Configuration or  Other Policy . The practical difference between the two options is that if you select  Running Configuration , the system limits one of your comparison choices to the set of currently applied file policies.
 
      	 [bookmark: pgfId-1602345]To compare revisions of the same policy, select  Other Revision .
 
     
 
    
 
    [bookmark: pgfId-1602346]The dialog box refreshes, displaying your comparison options.
 
    [bookmark: pgfId-1602347]Step 4 Depending on the comparison type you selected, you have the following choices:
 
     
      
      	 [bookmark: pgfId-1602348]If you are comparing two different policies, select the policies you want to compare:  Policy A or  Target/Running Configuration A , and  Policy B .
 
      	 [bookmark: pgfId-1602349]If you are comparing revisions of the same policy, select the  Policy you want to use, then select the two revisions:  Revision A and  Revision B . Revisions are listed by date and user name.
 
     
 
    
 
    [bookmark: pgfId-1602350]Step 5 Click OK.
 
    [bookmark: pgfId-1602351]The comparison view appears.
 
    [bookmark: pgfId-1602352]Step 6 Optionally, click Comparison Report to generate the access control policy comparison report. 
 
    [bookmark: pgfId-1688400]The comparison report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
    [bookmark: pgfId-2074432]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1688407][bookmark: 18377]Working with [bookmark: marker-1688402]Cloud Connections for FireAMP
 
    [bookmark: pgfId-1688408]License: Any
 
    [bookmark: pgfId-1649976]FireAMP is Cisco’s enterprise-class advanced malware analysis and protection solution. If your organization has a FireAMP su[bookmark: marker-1774743]bscription, individual users install FireAMP Connect[bookmark: marker-1739812]ors on their computers and mobile devices. These lightweight agents communicate with the Cisco cloud, which in turn communicates with the Defense Center. After you configure the Defense Center to connect to the cloud, you can receive records of scans, malware detections, and quarantines. The records are stored in the Defense Center database as malware events. For more information, see Understanding Malware Protection and File Control.
 
    [bookmark: pgfId-2088080]If your organization’s security policy does not allow for the use of a traditional cloud server connection, you can acquire and configure Cisco’s private, on-premises cloud solution, the FireAMP Private Cloud, which is a virtual machine that acts as a compressed, local version of the public Cisco cloud. In this case, data and actions that usually involve a cloud connection (such as events from FireAMP connectors, file disposition lookups, retrospective events, and so on) are instead handled by a local connection to your private cloud. When connections to the external cloud are necessary (such as for file disposition lookups), the private cloud acts as an anonymized proxy between your Defense Center and the public Cisco cloud. With a private cloud, no endpoint event data is shared over an external connection. For more information on configuring a private cloud, see Working with the FireAMP Private Cloud.
 
     
      
    
 
    
 
    [bookmark: pgfId-2119570]Note The private cloud does not support dynamic analysis.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2081474]Hosts where FireAMP Connectors are installed can also generate indications of compromise (IOC) tags when endpoint-based malware detection activity detected on that host suggests that the host’s security may be compromised. To view endpoint IOC information for a host from a Defense Center, that host must appear in the Defense Center’s network map. Cisco occasionally develops new IOC types for endpoint-based malware events, which your system automatically downloads from the Cisco cloud. For more information on indications of compromise, see Understanding Indications of Compromise and Endpoint-Based Malware Event IOC Types.
 
    [bookmark: pgfId-1649436]Each Defense Center in your deployment can connect to the Cisco cloud. By default, the cloud sends malware events for all groups within your organization, but you can restrict by group when you configure the connection.
 
    [bookmark: pgfId-1603677]Internet A[bookmark: marker-1697705]ccess and High Availability
 
    [bookmark: pgfId-1603678]The system uses port 443/HTTPS to connect to the Cisco cloud (public or private) to receive endpoint-based malware events. You must open that port, both inbound and outbound, on the Defense Center. Additionally, the Defense Center must have direct access to the Internet. The default h[bookmark: marker-1603621]ealth policy includes the FireAMP Status Monitor, which warns you if the Defense Center cannot connect to the cloud after an initial successful connection, or if the connection is deregistered using the FireAMP portal.
 
    [bookmark: pgfId-2100184][bookmark: marker-2100183]Cloud connections to receive endpoint-based malware events are not shared between members of a high availability pair. To ensure continuity of operations, connect both the primary and secondary Defense Centers to the cloud.
 
    [bookmark: pgfId-2100192]Managing Cloud Connections
 
    [bookmark: pgfId-1602407]Use the Defense Center’s AMP Management page (AMP > AMP Management) to view and create connections to the Cisco cloud or a private cloud, as well as disable and delete those connections.
 ) indicates that the cloud denied the connection or the connection failed for another reason. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1678537]Tip Click any cloud name to open the FireAMP portal in a new browser window.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1602420]For more information, see:
 
     
     	 [bookmark: pgfId-1602424]Creating a Cisco Cloud Connection
 
     	 [bookmark: pgfId-1602428]Deleting or Disabling a Cloud Connection
 
     	 [bookmark: pgfId-2089738]Working with the FireAMP Private Cloud
 
    
 
     
      [bookmark: pgfId-1602431][bookmark: 78828]Creating a Cisco Cloud Connection
 
     [bookmark: pgfId-1602432]License: Any
 
     [bookmark: pgfId-1602437]Creating a connection between the Defense Center and the Cisco cloud is a two-step process. First, configure the Defense Center to connect to the cloud. Then, log into the FireAMP portal to authorize the connection. If you do not have a FireAMP subscription, you cannot complete the registration process.
 
     [bookmark: pgfId-1844396]By default, there is a connection to the public US Cloud that is enabled for network-based AMP. This connection is used for file lookups in file policies. 
 
     [bookmark: pgfId-2149405]To re-register a Defense Center that was restored to factory defaults or reverted while registered to the cloud, you must connect to FireAMP and remove the Defense Center before re-registering it. 
 
     [bookmark: pgfId-1602441]To create a Cisco cloud connection for FireAMP:
 
     [bookmark: pgfId-1602442]Access: Admin
 
     
 
     [bookmark: pgfId-2091332]Step 1 Select AMP > AMP Management.
 
     [bookmark: pgfId-2091336]The AMP Management page appears.
 
     [bookmark: pgfId-2091340]Step 2 Click Create FireAMP Connection.
 
     [bookmark: pgfId-1602446]The Create FireAMP Connection dialog box appears.
 
     [bookmark: pgfId-1602451]Step 3 From the Cloud Name drop-down box, select the cloud you want to use:
 
      
       
       	 [bookmark: pgfId-2091389]For the European Union cloud, select  EU Cloud .
 
       	 [bookmark: pgfId-2091449]For the United States of America cloud, select  US Cloud .
 
       	 [bookmark: pgfId-2091508]For a private cloud, select  Private Cloud , then follow the additional steps under Working with the FireAMP Private Cloud.
 
      
 
     
 
     [bookmark: pgfId-2091381]Step 4 Click Register.
 
     [bookmark: pgfId-1602452]Step 5 Confirm that you want to continue to the FireAMP portal, then log into the portal.
 
     [bookmark: pgfId-1602453]The Applications page on the portal appears. Use this page to authorize the Cisco cloud to send malware events to the Defense Center.
 
     [bookmark: pgfId-1602457]Step 6 Optionally, select specific groups within your organization for which you want to receive malware events.
 
     [bookmark: pgfId-1602458]Select groups only if you want to restrict the events you receive. By default, the Defense Center receives malware events for all groups. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1602462]Tip To manage groups, select Management > Groups on the FireAMP portal. For detailed information, refer to the online help on the portal. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1602463]Step 7 Click Allow.
 
     [bookmark: pgfId-1602467]You are returned to the FireAMP Management page on the Defense Center. Your connection is enabled and the Defense Center begins receiving malware events from the cloud.
 
     [bookmark: pgfId-1602474]Clicking Deny also returns you to the Defense Center, where the cloud connection is marked as denied. Similarly, if you navigate away from the Applications page on the FireAMP portal, and neither deny nor allow the connection, the connection is marked as pending on the Defense Center’s web interface. The health monitor does not alert in either of these situations. If you want to connect to the cloud later, you must delete the failed or pending connection, then recreate it.
 
     [bookmark: pgfId-2148728]Incomplete registration of an endpoint-based FireAMP connection does not disable the network-based AMP connection. 
 
     [bookmark: pgfId-2074441]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1602480][bookmark: 65768]Deleting or Disabling a Cloud Connection
 
     [bookmark: pgfId-1602481]License: Any
 
     [bookmark: pgfId-2149338]Delete a Cisco cloud connection or private cloud connection if you no longer want to receive malware events from the cloud. You cannot delete the cloud connection that is enabled for network-based AMP. 
 
     [bookmark: pgfId-2149502]To temporarily stop malware events from being sent for a particular connection, you can disable the connection rather than deleting it. In this situation, the cloud stores the events until you re-enable the connection; the cloud then sends the stored events.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2149340] 
      Caution In rare cases — for example, with a very high event rate or a long-term disabled connection — the cloud may not be able to store all events generated while the connection is disabled. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1602484]Note that deregistering a connection using the FireAMP portal (instead of the Defense Center’s web interface) stops events from being sent, but does not remove the connection from the Defense Center. Deregistered connections show a failed state on the FireAMP Management page and you must delete them.
 
     [bookmark: pgfId-1602494]To enable or disable a cloud connection using the Defense Center:
 
     [bookmark: pgfId-1602495]Access: Admin
 
     
 
     [bookmark: pgfId-1602496]Step 1 On the AMP Management page, next to the connection you want to delete, click the slider, then confirm that you want to either enable or disable the connection.
 
     [bookmark: pgfId-1602497]When you enable a connection, the cloud begins sending events to the Defense Center, including any events that occurred while the connection was disabled. The cloud does not send events for disabled connections.
 
     [bookmark: pgfId-2074447]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1602504]To delete a cloud connection using the Defense Center:
 
     [bookmark: pgfId-1602505]Access: Admin
 
     
 ), then confirm you want to remove the connection. 
     
 
     [bookmark: pgfId-1602510]The connection is removed and the cloud stops sending events to the Defense Center.
 
     [bookmark: pgfId-2074455]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2089666][bookmark: 58921]Working with the FireAMP Private Cloud
 
     [bookmark: pgfId-2089830]License: Any
 
     [bookmark: pgfId-2098225]Your organization may have privacy or security concerns that make frequent connections between your monitored network and an external cloud server difficult or impossible. In this case, you can acquire and configure the FireAMP Private Cloud, which is a proprietary Cisco virtual machine that acts as a secure mediator between your network and the Cisco FireAMP cloud. Instead of identifiable connections from many appliances, all necessary connections to the public, external Cisco cloud are funneled through the private cloud, which acts as an anonymized proxy to ensure the security and privacy of your monitored network. Each private cloud can support as many as 10,000 separate connectors. You can configure multiple private clouds on your network to meet your organization’s needs.
 
     [bookmark: pgfId-2099356]The FireAMP Private Cloud handles the cloud-based actions of file disposition lookup, endpoint-based FireAMP event retrieval, and retrospective malware event generation. The private cloud, acting in place of the public cloud, collects malware events from FireAMP Connector endpoints and transmits them to the Defense Center. Only queries to the public Cisco cloud (to determine file dispositions, SHA-256 values, and so on) leave your network, through the anonymized, proxied private cloud connection. Endpoint event data never leaves your network.
 
     [bookmark: pgfId-2100485]For more information on cloud-based file and malware features, see:
 
      
      	 [bookmark: pgfId-2099366]Understanding Malware Protection and File Control
 
      	 [bookmark: pgfId-2099510]Integrating FireAMP with the FireSIGHT System
 
      	 [bookmark: pgfId-2099390]Working with Dynamic Analysis
 
      	 [bookmark: pgfId-2099440]Endpoint-Based (FireAMP) Malware Events
 
      	 [bookmark: pgfId-2099451]Retrospective Malware Events
 
     
 
     [bookmark: pgfId-2100525]In this and other documentation related to the private cloud’s supported features, all references to the “cloud” or the “Cisco cloud” apply to connections through a private cloud as well, unless otherwise noted. The private cloud requires the same open ports and has the same high availability limitations as a standard cloud connection.
 
      
       
     
 
     
 
     [bookmark: pgfId-2098441]Note The FireAMP Private Cloud supports only malware- and file-related cloud-based features. It does not support other FireSIGHT System features that use cloud connections, such as URL filtering or Security Intelligence. The private cloud also does not support the dynamic analysis feature, although you can use the private cloud to retrieve threat scores for files that Cisco has already dynamically analyzed.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2098794]To create a connection between a Defense Center and a FireAMP Private Cloud, you must first configure your FireAMP Private Cloud according to the procedures in the FireAMP Private Cloud Administration Portal User Guide, available on the Support Site. During this configuration, make sure to note the private cloud host name that appears in the FireAMP Console field; you must have this host name to connect the private cloud to your Defense Center. Note that successfully configuring a private cloud automatically disables any public cloud connections you may have configured.
 
     [bookmark: pgfId-2091653]To create a connection between your Defense Center and a FireAMP Private Cloud:
 
     [bookmark: pgfId-2091657]Access: Admin
 
     
 
     [bookmark: pgfId-2091732]Step 1 Select AMP > AMP Management.
 
     [bookmark: pgfId-2091820]The AMP Management page appears.
 
     [bookmark: pgfId-2091859]Step 2 Click Create FireAMP Connection.
 
     [bookmark: pgfId-2091900]The Create FireAMP Connection dialog box appears.
 
     [bookmark: pgfId-2091902]Step 3 From the Cloud Name drop-down list, select Private Cloud.
 
     [bookmark: pgfId-2091988]Additional fields appear in the dialog box.
 
     [bookmark: pgfId-2092034]Step 4 In the Name field, type a name for your private cloud connection. This name appears in the FireAMP Cloud event field when you view malware events.
 
     [bookmark: pgfId-2092228]Step 5 In the Host field, type the host name of your private cloud, as displayed in the FireAMP Console field when you configured your FireAMP Private Cloud virtual machine.
 
     [bookmark: pgfId-2092291]Step 6 In the Certificate Upload Path field, browse to the location of a valid TLS or SSL encryption certificate information for your private cloud. For more information, see the FireAMP Private Cloud Administration Portal User Guide.
 
     [bookmark: pgfId-2097216]Step 7 If you have more than one private cloud configured for your monitored network and want to determine which private cloud handles network-based malware lookups, select or clear the Use For NetworkAMP check box. When only one private cloud is configured, the box is checked by default and cannot be cleared.
 
     [bookmark: pgfId-2120073]Step 8 If you have a proxy connection configured on your Defense Center and want to use that proxy connection for the private cloud, select the Use Proxy for Connection check box. If this option is not selected, the private cloud does not use your configured proxy for its communications.
 
     [bookmark: pgfId-2093274]Step 9 Click Register.
 
     [bookmark: pgfId-2096746]A dialog box appears to remind you that creating a private cloud configuration disables all public cloud connections you may have configured.
 
     [bookmark: pgfId-2096588]Step 10 Click Yes.
 
     [bookmark: pgfId-2096933]Confirm that you want to continue to the FireAMP portal, then log into the portal.
 
     [bookmark: pgfId-2096971]Step 11 The system processes your private cloud information and redirects you to the FireAMP site to complete configuration. For further instructions, please refer to the FireAMP Private Cloud Administration Portal User Guide.
 
     [bookmark: pgfId-1813762]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 29886]Logging Connections in Network Traffic 
      
      
 
     
 
 
    [bookmark: pgfId-1562069]As managed devices monitor traffic generated by the hosts on your network, they can generate logs of the connections they detect. Various settings in access control and SSL policies give you granular control over which connections you log, when you log them, and where you store the data. An access control rule’s specific logging configuration also determines whether you log file and malware events associated with the connection.
 
    [bookmark: pgfId-1594139]In most cases, you can log a connection at its beginning or its end, or both. When you log a connection, the system generates a connection event. You can also log a special kind of connection event, called a Security Intelligence event, whenever a connection is blacklisted (blocked) by the reputation-based Security Intelligence feature. 
 
    [bookmark: pgfId-1561346]Connection events contain data about the detected sessions. The information available for any individual connection event depends on several factors, but in general includes:
 
     
     	 [bookmark: pgfId-1566025]basic connection properties: timestamp, source and destination IP address, ingress and egress zones, the device that handled the connection, and so on
 
     	 [bookmark: pgfId-1566026]additional connection properties discovered or inferred by the system: applications, requested URLs, or users associated with the connection, and so on
 
     	 [bookmark: pgfId-1566027]metadata about why the connection was logged: which access control rule (or other configuration) in which policy handled the traffic, whether the connection was allowed or blocked, details about encrypted and decrypted connections, and so on
 
    
 
    [bookmark: pgfId-1603855]You should log connections according to the security and compliance needs of your organization. You can log any connection except those that are fast-pathed at the device level before they reach access control.
 
    [bookmark: pgfId-1561347]Saving connection events to the Defense Center database allows you to take advantage of many reporting, analysis, and data correlation features of the FireSIGHT System; see Working with Connection & Security Intelligence Data. Or, you can send connection data to an external system log (syslog) or SNMP trap server.
 
    [bookmark: pgfId-1603811]To supplement the connection data gathered by your managed devices, you can use records generated by NetFlow-enabled devices to generate connection events. This is especially useful if you have NetFlow-enabled devices deployed on networks that your FireSIGHT System managed devices cannot monitor.
 
     
      
    
 
    
 
    [bookmark: pgfId-1561351]Note Because NetFlow data collection is not linked to access control, you do not have granular control over which NetFlow connections you want to log. FireSIGHT System managed devices detect records exported by NetFlow-enabled devices, generate unidirectional end-of-connection events based on the data in those records, and finally send those events to the Defense Center to be logged in the database. NetFlow records cannot generate Security Intelligence events, nor be logged to an external server. For more information, see Understanding NetFlow.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1580188]For more information on logging connection data, see:
 
     
     	 [bookmark: pgfId-1543531]Deciding Which Connections To Log
 
     	 [bookmark: pgfId-1543564]Logging Security Intelligence (Blacklisting) Decisions
 
     	 [bookmark: pgfId-1543594]Logging Encrypted Connections
 
     	 [bookmark: pgfId-1545312]Logging Connections Based on Access Control Handling
 
     	 [bookmark: pgfId-1546417]Logging URLs Detected in Connections
 
    
 
   
 
    
     [bookmark: pgfId-1545314][bookmark: 98684]Deciding Which Connections To Log
 
    [bookmark: pgfId-1562232]License: Any
 
    [bookmark: pgfId-1636598]Using various settings in access control and SSL policies, you can log any non-fast-pathed connection that your devices monitor. In most cases, you can log a connection at its beginning or its end, or both. However, because blocked traffic is immediately denied without further inspection, in most cases you can log only beginning-of-connection events for blocked or blacklisted traffic; there is no unique end of connection to log.
 
    [bookmark: pgfId-1566210]When you log a connection event, you can save it to the Defense Center database for further analysis using the FireSIGHT System. Or, you can send connection data to an external syslog or SNMP trap server.
 
     
      
    
 
    
 
    [bookmark: pgfId-1566217]Tip To perform detailed analysis of connection data using the FireSIGHT System, Cisco recommends you log the ends of critical connections to the Defense Center database. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1603867]For more information, see:
 
     
     	 [bookmark: pgfId-1554855]Logging Critical Connections
 
     	 [bookmark: pgfId-1555235]Logging the Beginning or End of Connections
 
     	 [bookmark: pgfId-1555248]Logging Connections to the Defense Center or External Server
 
     	 [bookmark: pgfId-1591033]Understanding How Access Control and SSL Rule Actions Affect Logging
 
     	 [bookmark: pgfId-1563278]License and Model Requirements for Connection Logging
 
    
 
     
      [bookmark: pgfId-1562739][bookmark: 85668]Logging Critical Connections
 
     [bookmark: pgfId-1599848]License: Any
 
     [bookmark: pgfId-1562767]You should log connections according to the security and compliance needs of your organization. If your goal is to limit the number of events you generate and improve performance, only enable logging for the connections critical to your analysis. However, if you want a broad view of your network traffic for profiling purposes, you can enable logging for additional connections. Various settings in access control and SSL policies give you granular control over which connections you log, when you log them, and where you store the data. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1624097] 
      Caution Logging blocked TCP connections during a Denial of Service (DoS) attack can affect system performance and overwhelm the database with multiple similar events. Before you enable logging for a Block rule, consider whether the rule monitors traffic on an Internet-facing interface or other interface vulnerable to DoS attack. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1616776]In addition to the logging that you configure, the system automatically logs most connections where the system detects a prohibited file, malware, or intrusion attempt. Unless you disable connection event storage entirely using the system policy, regardless of your other logging configurations, the system saves these end-of-connection events to the Defense Center database for further analysis. All connection events reflect why they were automatically logged using the Action and Reason fields; see Action and Reason.
 
     [bookmark: pgfId-1554790]Security Intelligence Blacklisting Decisions (Optional)
 
     [bookmark: pgfId-1617083]You can log a connection whenever it is blacklisted (blocked) by the reputation-based Security Intelligence feature. Optionally, and recommended in passive deployments, you can use a monitor-only setting for Security Intelligence filtering. This allows the system to further analyze connections that would have been blacklisted, but still log the match to the blacklist. Security Intelligence monitoring also allows you to create traffic profiles using Security Intelligence information.
 
     [bookmark: pgfId-1617084]When you enable Security Intelligence logging, blacklist matches generate Security Intelligence events as well as connection events. A Security Intelligence event is a special kind of connection event that you can view and analyze separately, and that is also stored and pruned separately. For more information, see Logging Security Intelligence (Blacklisting) Decisions.
 
     [bookmark: pgfId-1554791]Encrypted Connections (Optional)
 
     [bookmark: pgfId-1555681]You can log a connection when the system blocks an encrypted session according to the settings in an SSL policy. You can also force the system to log connections that it passes for further evaluation by access control rules, regardless of whether you decrypt the traffic, and regardless of how the system later handles or inspects the traffic. You configure this logging on a per-SSL rule basis so that you only log critical connections. For more information, see Logging Encrypted Connections.
 
     [bookmark: pgfId-1554792]Access Control Handling (Optional)
 
     [bookmark: pgfId-1616814]You can log a connection when it is handled by an access control rule or the access control default action. You configure this logging on a per-access control rule basis so that you only log critical connections. For more information, see Logging Connections Based on Access Control Handling.
 
     [bookmark: pgfId-1616820][bookmark: 91752]Connec[bookmark: marker-1616819]tions Associated with Intrusions (Automatic)
 
     [bookmark: pgfId-1616823]When an intrusion policy invoked by an access control rule (see Tuning Traffic Flow Using Access Control Rules) detects an intrusion and generates an intrusion event, the system automatically logs the end of the connection where the intrusion occurred to the Defense Center database, regardless of the logging configuration of the rule.
 
     [bookmark: pgfId-1558178]However, when an intrusion policy associated with the access control default action (see Setting Default Handling and Inspection for Network Traffic) generates an intrusion event, the system does not automatically log the end of the associated connection. Instead, you must explicitly enable default action connection logging. This is useful for intrusion prevention-only deployments where you do not want to log any connection data. 
 
     [bookmark: pgfId-1558274]For connections where an intrusion was blocked, the action for the connection in the connection log is Block, with a reason of Intrusion Block, even though to perform intrusion inspection you must use an Allow rule.
 
      
       
     
 
     
 
     [bookmark: pgfId-1616799]Tip To disable this connection logging on Series 3 or virtual devices, use the CLI; see log-ips-connections.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1616803][bookmark: 65073]Conne[bookmark: marker-1616802]ctions Associated with File and Malware Events (Automatic)
 
     [bookmark: pgfId-1616804]When a file policy invoked by an access control rule detects a prohibited file (including malware) and generates a file or malware event, the system automatically logs the end of the connection where the file was detected to the Defense Center database, regardless of the logging configuration of the access control rule. You cannot disable this logging.
 
      
       
     
 
     
 
     [bookmark: pgfId-1557905]Note File events generated by inspecting NetBIOS-ssn (SMB) traffic do not immediately generate connection events because the client and server establish a persistent connection. The system generates connection events after the client or server ends the session.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1604679]For connections where a file was blocked, the action for the connection in the connection log is Block even though to perform file and malware inspection you must use an Allow rule. The connection’s reason is either File Monitor (a file type or malware was detected), or Malware Block or File Block (a file was blocked).
 
    
 
     
      [bookmark: pgfId-1604681][bookmark: 15726]Logging the Beginning or End of Connections
 
     [bookmark: pgfId-1604685]License: Any
 
     [bookmark: pgfId-1555365]When the system detects a connection, in most cases you can log it at its beginning or its end.
 
     [bookmark: pgfId-1622138]However, because blocked traffic is immediately denied without further inspection, in most cases you can log only beginning-of-connection events for blocked or blacklisted traffic; there is no unique end of connection to log. An exception occurs when you block encrypted traffic. When you enable connection logging in an SSL policy, the system logs end-of-connection rather than beginning-of-connection events. This is because the system cannot determine if a connection is encrypted using the first packet in the session, and thus cannot immediately block encrypted sessions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1616418]Note For a single non-blocked connection, the end-of-connection event contains all of the information in the beginning-of-connection event, as well as information gathered over the duration of the session. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1616432]To optimize performance, log either the beginning or the end of any connection, but not both. You can trigger correlation rules based on either beginning or end-of-connection events. Note that monitoring a connection for any reason forces end-of-connection logging; see Understanding Logging for Monitored Connections.
 
     [bookmark: pgfId-1616419]The following table details the differences between beginning and end-of-connection events, including the advantages to logging each. 
 
     [bookmark: pgfId-1626148]
 
      
       
        
        
        
         
         	 
           
           [bookmark: pgfId-1626111]Beginning-of-Connection Events 
          
  
         	 
           
           [bookmark: pgfId-1626113]End-of-Connection Events 
          
  
        
 
         
         	[bookmark: pgfId-1626115]Can be generated...
  
         	[bookmark: pgfId-1626117]when the system detects the beginning of a connection (or, after the first few packets if event generation depends on application or URL identification)
  
         	[bookmark: pgfId-1626119]when the system:
 
           
           	 [bookmark: pgfId-1626120]detects the close of a connection
 
           	 [bookmark: pgfId-1626121]does not detect the end of a connection after a period of time
 
           	 [bookmark: pgfId-1626122]can no longer track the session due to memory constraints
 
          
  
        
 
         
         	[bookmark: pgfId-1626124]Can be logged for...
  
         	[bookmark: pgfId-1637092]all connections evaluated by Security Intelligence or access control rules, though you may not be able to configure end-of-connection logging in all places
  
         	[bookmark: pgfId-1626129]all connections, though you may not be able to configure end-of-connection logging in all places
  
        
 
         
         	[bookmark: pgfId-1626132]Contain...
  
         	[bookmark: pgfId-1626134]only information that can be determined in the first packet (or the first few packets, if event generation depends on application or URL identification)
  
         	[bookmark: pgfId-1626136]all information in the beginning-of-connection event, plus information determined by examining traffic over the duration of the session, for example, the total amount of data transmitted or the timestamp of the last packet in the connection
  
        
 
         
         	[bookmark: pgfId-1626138]Are useful...
  
         	[bookmark: pgfId-1626140]if you want to log:
 
           
           	 [bookmark: pgfId-1626141]blocked connections, including Security Intelligence blacklisting decisions
 
           	 [bookmark: pgfId-1626142]only the beginning of a connection because the end-of-connection information does not matter to you
 
          
  
         	[bookmark: pgfId-1626144]if you want to:
 
           
           	 [bookmark: pgfId-1626145]log encrypted connections handled by an SSL policy
 
           	 [bookmark: pgfId-1626146]perform any kind of detailed analysis on, or trigger correlation rules using, information collected over the duration of the session
 
           	 [bookmark: pgfId-1626147]view connection summaries (aggregated connection data) in custom workflows, view connection data in graphical format, or create and use traffic profiles
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1626150][bookmark: 61659]Logging Connections to the Defense Center or External Server
 
     [bookmark: pgfId-1626154]License: Any
 
     [bookmark: pgfId-1565705]You can log connection events to the Defense Center database, as well as to an external syslog or SNMP trap server. Before you can log connection data to an external server, you must configure a connection to that server called an alert response; see Working with Alert Responses.
 
     [bookmark: pgfId-1565642]Logging to the Defense Center database allows you to take advantage of many reporting, analysis, and data correlation features of the FireSIGHT System. For example:
 
      
      	 [bookmark: pgfId-1563734]Dashboards and the Context Explorer provide you with graphical, at-a-glance views of the connections logged by the system; see Using Dashboards and Using the Context Explorer.
 
      	 [bookmark: pgfId-1563669]Event views present detailed information on the connections logged by the system, which you can display in a graphical or tabular format or summarize in a report; see Working with Connection & Security Intelligence Data.
 
      	 [bookmark: pgfId-1562861]Traffic profiling uses connection data to create a profile of your normal network traffic that you can then use as a baseline against which to detect and track anomalous behavior; see Creating Traffic Profiles.
 
      	 [bookmark: pgfId-1562865]Correlation policies allow you to generate events and trigger responses (such as alerts or external remediations) to specific types of connections or traffic profile changes; see Creating Rules for Correlation Policies.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1564742]Note To use these features, you must log connections (and in most cases, the end of those connections rather than the beginning) to the Defense Center database. This is why the system automatically logs critical connections—those associated with logged intrusions, prohibited files, and malware.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1564723]The number of connection and Security Intelligence events a Defense Center can store depends on its model. For a list of those limits, and for information on disabling connection event storage, see Configuring Database Event Limits.
 
    
 
     
      [bookmark: pgfId-1633679][bookmark: 90887]Understanding How Access Control and SSL Rule Actions Affect Logging
 
     [bookmark: pgfId-1633683]License: feature dependent
 
     [bookmark: pgfId-1633684]Every access control and SSL rule has an action that determines not only how the system inspects and handles the traffic that matches the rule, but also when and how you can log details about matching traffic.
 
      
       
     
 
     
 
     [bookmark: pgfId-1602369]Note Logging connections allowed by the access control and SSL policy default actions is handled slightly differently; see Logging Connections Handled by the Access Control Default Action and Setting Default Logging for Encrypted and Undecryptable Connections.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1594186]For more information, see:
 
      
      	 [bookmark: pgfId-1591739]Using Rule Actions to Determine Traffic Handling and Inspection
 
      	 [bookmark: pgfId-1592589]Using Rule Actions to Determine Encrypted Traffic Handling and Inspection
 
      	 [bookmark: pgfId-1591743]Understanding Logging for Monitored Connections
 
      	 [bookmark: pgfId-1591747]Understanding Logging for Trusted Connections
 
      	 [bookmark: pgfId-1591751]Understanding Logging for Blocked and Interactively Blocked Connections
 
      	 [bookmark: pgfId-1591755]Understanding Logging for Allowed Connections
 
      	 [bookmark: pgfId-1592002]Disabling File and Malware Event Logging for Allowed Connections
 
     
 
    
 
     
      [bookmark: pgfId-1591365][bookmark: 79731]Understanding Loggin[bookmark: marker-1591364]g for Monitored Connections
 
     [bookmark: pgfId-1633701]License: feature dependent
 
     [bookmark: pgfId-1591370]The system always logs the ends of the following connections to the Defense Center database, regardless of the logging configuration of the rule or default action that later handles the connection:
 
      
      	 [bookmark: pgfId-1613854]connections matching a Security Intelligence blacklist set to monitor
 
      	 [bookmark: pgfId-1614044]connections matching an SSL Monitor rule
 
      	 [bookmark: pgfId-1614001]connections matching an access control Monitor rule
 
     
 
     [bookmark: pgfId-1614637]In other words, if a packet matches a Monitor rule or Security Intelligence monitored blacklist, the connection is always logged, even if the packet matches no other rules and you do not enable logging on the default action. Whenever the system logs a connection event as the result of Security Intelligence filtering, it also logs a matching Security Intelligence event, which is a special kind of connection event that you can view and analyze separately; see Logging Security Intelligence (Blacklisting) Decisions.
 
     [bookmark: pgfId-1602790]Because monitored traffic is always later handled by another rule or by the default action, the action associated with a connection logged due to a monitor rule is never Monitor. Rather, it reflects the action of the rule or default action that later handles the connection; see Action. 
 
     [bookmark: pgfId-1608191]The system does not generate a separate event each time a single connection matches an SSL or access control Monitor rule. Because a single connection can match multiple Monitor rules, each connection event logged to the Defense Center database can include and display information on the first eight Monitor access control rules that the connection matches, as well as the first matching Monitor SSL rule.
 
     [bookmark: pgfId-1591378]Similarly, if you send connection events to an external syslog or SNMP trap server, the system does not send a separate alert each time a single connection matches a Monitor rule. Rather, the alert that the system sends at the end of the connection contains information on the Monitor rules the connection matched.
 
      
       
     
 
     
 
     [bookmark: pgfId-1637139]Tip Even though the rule action in the connection log can never be Monitor, you can still trigger correlation policy violations on connections that match Monitor rules. For more information, see Specifying Correlation Rule Trigger Criteria.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1637144][bookmark: 41321]Understanding Logging for Trusted Connections
 
     [bookmark: pgfId-1637148]License: feature dependent
 
     [bookmark: pgfId-1637198]A trusted connection is one that is handled by a Trust access control rule or the default action in an access control policy. You can log the beginnings and ends of these connections, however, keep in mind that trusted connections, regardless of whether they are encrypted, are not inspected for discovery data, intrusions, or prohibited files and malware. Therefore, connection events for trusted connections contain limited information.
 
     [bookmark: pgfId-1591387]Note that the system logs TCP connections handled by a Trust access control rule differently depending on the device that detected the connection:
 
      
      	 [bookmark: pgfId-1591391]For Series 3 devices, TCP connections detected by a Trust rule on the first packet generate different events depending on the presence of a preceding enabled Monitor rule. If the Monitor rule is active, the system evaluates the packet and generates both a beginning and end-of-connection event. If no Monitor rule is active, the system only generates an end-of-connection event.
 
      	 [bookmark: pgfId-1591392]For all other models, TCP connections detected by a Trust rule on the first packet only generate an end-of-connection event. The system generates the event one hour after the final session packet.
 
     
 
    
 
     
      [bookmark: pgfId-1591395][bookmark: 75420]Understanding Logging for Blocked and Interactively Blocked Connections[bookmark: marker-1591394]
 
     [bookmark: pgfId-1633739]License: feature dependent
 
     [bookmark: pgfId-1620142]When you log a blocked connection, how the system logs it depends on why the connection was blocked; this is important to keep in mind when configuring correlation rules based on connection logs:
 
      
      	 [bookmark: pgfId-1620804]For SSL rules and SSL policy default actions that block encrypted traffic, the system logs  end -of-connection events. This is because the system cannot determine if a connection is encrypted using the first packet in the session.
 
      	 [bookmark: pgfId-1620155]For access control rules and access control policy default actions that block decrypted or unencrypted traffic (including interactive blocking rules), the system logs  beginning -of-connection events. Matching traffic is denied without further inspection.
 
     
 
     [bookmark: pgfId-1608292]Connection events for sessions blocked by an access control or SSL rule have an action of Block or Block with reset. Blocked encrypted connections have a reason of SSL Block.
 
     [bookmark: pgfId-1608293]Interactive blocking access control rules, which cause the system to display a warning page when a user browses to a prohibited website, allow you to configure end-of-connection logging. This is because if the user clicks through the warning page, the connection is considered a new, allowed connection which the system can monitor and log; see Understanding Logging for Allowed Connections.
 
     [bookmark: pgfId-1591398]Therefore, for packets that match an Interactive Block or Interactive Block with reset rule, the system can generate the following connection events:
 
      
      	 [bookmark: pgfId-1591399]a beginning-of-connection event when a user’s request is initially blocked and the warning page is displayed; this event has an associated action of Interactive Block or  Interactive Block with reset 
 
      	 [bookmark: pgfId-1591400]multiple beginning- or end-of-connection events if the user clicks through the warning page and loads the originally requested page; these events have an associated action of  Allow and a reason of  User Bypass 
 
     
 
     [bookmark: pgfId-1607588]Note that only devices deployed inline can block traffic. Because blocked connections are not actually blocked in passive deployments, the system may report multiple beginning-of-connection events for each blocked connection.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1624162] 
      Caution Logging blocked TCP connections during a Denial of Service (DoS) attack can affect system performance and overwhelm the database with multiple similar events. Before you enable logging for an Block rule, consider whether the rule monitors traffic on an Internet-facing interface or other interface vulnerable to DoS attack. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1591403][bookmark: 81351]Understanding Logging for Allowed Connections
 
     [bookmark: pgfId-1633762]License: feature dependent
 
     [bookmark: pgfId-1594618]Decrypt SSL rules, Do not decrypt SSL rules, and Allow access control rules permit matching traffic to pass to the next phase of inspection and traffic handling.
 
     [bookmark: pgfId-1598508]Regardless of whether you decrypt encrypted traffic using an SSL rule, the traffic continues to be evaluated by access control rules. If you enable logging for this SSL rule, the system logs the end of matching connections, regardless of the logging configuration of the access control rules or default action that later handles them. 
 
     [bookmark: pgfId-1594642]When you allow traffic with an access control rule, you can use an associated intrusion or file policy (or both) to further inspect traffic and block intrusions, prohibited files, and malware before the traffic can reach its final destination. Note, however, that by default file and intrusion inspection is disabled for encrypted payloads.
 
     [bookmark: pgfId-1637513]Connections for traffic matching an Allow access control rule are logged as follows:
 
      
      	 [bookmark: pgfId-1597679]When an intrusion policy invoked by an access control rule detects an intrusion and generates an intrusion event, the system automatically logs the end of the connection where the intrusion occurred to the Defense Center database, regardless of the logging configuration of the rule.
 
      	 [bookmark: pgfId-1597702]When a file policy invoked by an access control rule detects a prohibited file (including malware) and generates a file or malware event, the system automatically logs the end of the connection where the file was detected to the Defense Center database, regardless of the logging configuration of the access control rule.
 
      	 [bookmark: pgfId-1597662]Optionally, you can enable beginning- and end-of-connection logging for any allowed traffic, including traffic that the system deems safe or that you do not inspect with an intrusion or file policy.
 
     
 
     [bookmark: pgfId-1597972]For all of the resulting connection events, the Action and Reason fields reflect why the events were logged; see Action and Reason. Note that:
 
      
      	 [bookmark: pgfId-1596473]An action of  Allow represents explicitly allowed and user-bypassed interactively blocked connections that reached their final destination.
 
      	 [bookmark: pgfId-1596474]An action of  Block represents a connection that was at first allowed by an access control rule, but where an intrusion, prohibited file, or malware was detected.
 
     
 
    
 
     
      [bookmark: pgfId-1596465][bookmark: 29120]Disabling F[bookmark: marker-1596464]ile and Malware Event Logging for Allowed Connections
 
     [bookmark: pgfId-1591420]License: Protection or Malware
 
     [bookmark: pgfId-1591424]Supported Devices: feature dependent
 
     [bookmark: pgfId-1591428]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1591429]When you allow unencrypted or decrypted traffic with an access control rule, you can use an associated file policy to inspect transmitted files, and block prohibited files and malware before it can reach its destination; see Tuning Intrusion Prevention Performance. Note that because you cannot use a Malware license with a DC500, nor enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances for malware protection.
 
     [bookmark: pgfId-1591442]When the system detects a prohibited file, it automatically logs one of the following types of event to the Defense Center database: 
 
      
      	 [bookmark: pgfId-1591446] file events , which represent detected or blocked files, including malware files
 
      	 [bookmark: pgfId-1591447] malware events , which represent detected or blocked malware files only
 
      	 [bookmark: pgfId-1591448] retrospective malware events , which are generated when the malware disposition for a previously detected file changes
 
     
 
     [bookmark: pgfId-1591449]If you do not want to log file or malware events, you can disable this logging on a per-access-control-rule basis by clearing the Log Files check box on the Logging tab of the access control rule editor. For information on disabling file and malware event storage entirely, see Configuring Database Event Limits.
 
      
       
     
 
     
 
     [bookmark: pgfId-1591456]Note Cisco recommends you leave file and malware event logging enabled.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1591457]Regardless of whether you save file and malware events, when network traffic violates a file policy, the system automatically logs the end of the associated connection to the Defense Center database, regardless of the logging configuration of the invoking access control rule; see Connections Associated with File and Malware Events (Automatic).
 
    
 
     
      [bookmark: pgfId-1546076][bookmark: 67019]License and Model Requirements for Conn[bookmark: marker-1569991]ection Logging
 
     [bookmark: pgfId-1570119]License: feature dependent
 
     [bookmark: pgfId-1570123]Because you configure connection logging in access control and SSL policies, you can log any connection that those policies can successfully handle.
 
     [bookmark: pgfId-1570232]Although you can create access control and SSL policies regardless of the licenses on your Defense Center, certain aspects of access control require that you enable specific licensed capabilities on target devices before you can apply the policy. Additionally, some features are only available on certain models.
 
     [bookmark: pgfId-1570636]Note that with a FireSIGHT license, which is included with your Defense Center, you can add host, user, and application data to the network map based on the information in connection logs, as well as view indications of compromise (IOC) information associated with connection events. Except on the DC500, you can also view geolocation data (source or destination country or continent) associated with connections.
 
     [bookmark: pgfId-1570637]The following table explains the licenses you must have to successfully configure access control, and therefore to log connections handled by an access control policy.
 
     [bookmark: pgfId-1570810]
 
      
       
        
        [bookmark: pgfId-1631599]Table 38-2 License and Model Requirements for Connection Logging in Access Control Policies 
 
        
        
         
         	 
           
           [bookmark: pgfId-1631607]To log connections... 
          
  
         	 
           
           [bookmark: pgfId-1631609]License 
          
  
         	 
           
           [bookmark: pgfId-1631614]Supported Defense Centers 
          
  
         	 
           
           [bookmark: pgfId-1631616]Supported Devices 
          
  
        
 
         
         	[bookmark: pgfId-1631618]for traffic handled using, network, VLAN, port, or literal URL criteria
  
         	[bookmark: pgfId-1631620]Any
  
         	[bookmark: pgfId-1631622]Any
  
         	[bookmark: pgfId-1631624]Any, except:
 
           
           	 [bookmark: pgfId-1631628]Series 2 devices cannot perform URL filtering
 
           	 [bookmark: pgfId-1631632]ASA FirePOWER devices cannot perform VLAN filtering
 
          
  
        
 
         
         	[bookmark: pgfId-1631634]for traffic handled using geolocation data
  
         	[bookmark: pgfId-1631639]FireSIGHT
  
         	[bookmark: pgfId-1631644]Any except DC500
  
         	[bookmark: pgfId-1631649]Any except Series 2 or X-Series
  
        
 
         
         	[bookmark: pgfId-1631654]associated with:
 
           
           	 [bookmark: pgfId-1631655]IP addresses with a poor reputation (Security Intelligence filtering)
 
           	 [bookmark: pgfId-1631656]intrusions or prohibited files in unencrypted or decrypted traffic
 
          
  
         	[bookmark: pgfId-1631661]Protection
  
         	[bookmark: pgfId-1631663]Any
  
         	[bookmark: pgfId-1631668]Any, except Series 2 devices cannot perform Security Intelligence filtering
  
        
 
         
         	[bookmark: pgfId-1631670]associated with malware detected in unencrypted or decrypted traffic
  
         	[bookmark: pgfId-1631675]Malware
  
         	[bookmark: pgfId-1631680]Any except DC500
  
         	[bookmark: pgfId-1631685]Any except Series 2 or X-Series
  
        
 
         
         	[bookmark: pgfId-1631687]for traffic handled by user control or application control
  
         	[bookmark: pgfId-1631692]Control
  
         	[bookmark: pgfId-1631697]Any, except the DC500 cannot perform user control
  
         	[bookmark: pgfId-1631702]Any except Series 2 or X-Series
  
        
 
         
         	[bookmark: pgfId-1631704]for traffic that the system filters using URL category and reputation data, and to display URL category and URL reputation information for URLs requested by monitored hosts
  
         	[bookmark: pgfId-1631709]URL Filtering
  
         	[bookmark: pgfId-1631714]Any except DC500
  
         	[bookmark: pgfId-1631719]Any except Series 2
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1628046]The following table explains the licenses you must have to successfully configure SSL inspection, and therefore to log connections handled by an SSL policy. Keep in mind that even if an encrypted connection is not logged (or even examined) by an SSL policy, it still may be logged for other reasons.
 
     [bookmark: pgfId-1628230]
 
      
       
        
        [bookmark: pgfId-1631964]Table 38-3 License and Model Requirements for Connection Logging in SSL Policies 
 
        
        
         
         	 
           
           [bookmark: pgfId-1631972]To log connections... 
          
  
         	 
           
           [bookmark: pgfId-1631974]License 
          
  
         	 
           
           [bookmark: pgfId-1631979]Supported Defense Centers 
          
  
         	 
           
           [bookmark: pgfId-1631981]Supported Devices 
          
  
        
 
         
         	[bookmark: pgfId-1631983]for encrypted traffic handled using zone, network, VLAN, port, or SSL-related criteria
  
         	[bookmark: pgfId-1631985]Any
  
         	[bookmark: pgfId-1631990]Any
  
         	[bookmark: pgfId-1631995]Series 3
  
        
 
         
         	[bookmark: pgfId-1634168]for encrypted traffic handled using geolocation data
  
         	[bookmark: pgfId-1634092]FireSIGHT
  
         	[bookmark: pgfId-1634094]Any except DC500
  
         	[bookmark: pgfId-1634096]Series 3
  
        
 
         
         	[bookmark: pgfId-1631997]for encrypted traffic handled using application or user criteria
  
         	[bookmark: pgfId-1631999]Control
  
         	[bookmark: pgfId-1634390]Any, except the DC500 cannot perform user control
  
         	[bookmark: pgfId-1632009]Series 3
  
        
 
         
         	[bookmark: pgfId-1632011]for encrypted traffic that the system filters using URL category and reputation data
  
         	[bookmark: pgfId-1632016]URL Filtering
  
         	[bookmark: pgfId-1634495]Any except DC500
  
         	[bookmark: pgfId-1632026]Series 3
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1530799][bookmark: 27595]Logging Sec[bookmark: marker-1556874]urity Intelligence (Blacklisting) Decisions
 
    [bookmark: pgfId-1556931]License: Protection
 
    [bookmark: pgfId-1556941]Supported Devices: Any except Series 2
 
    [bookmark: pgfId-1556948]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1570864]As a first line of defense against malicious Internet content, the FireSIGHT System includes the Security Intelligence feature, which allows you to immediately blacklist (block) connections based on the latest reputation intelligence, removing the need for a more resource-intensive, in-depth analysis. This traffic filtering takes place before any other policy-based inspection, analysis, or traffic handling, although it does occur after hardware-level handling, such as fast-pathing. 
 
    [bookmark: pgfId-1617392]Optionally, and recommended in passive deployments, you can use a monitor-only setting for Security Intelligence filtering. This allows the system to further analyze connections that would have been blacklisted, but still log the match to the blacklist.
 
     
      
    
 
    
 
    [bookmark: pgfId-1619479]Note If you want to create traffic profiles based on Security Intelligence information, or trigger correlation rules using Security Intelligence information in end-of-connection events, you must log this information to the Defense Center database. First, enable Security Intelligence logging. Then, build a blacklist using monitor-only Security Intelligence objects. For more information, see Blacklisting Using Security Intelligence IP Address Reputation.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1617396]Enabling Security Intelligence logging logs all blocked and monitored connections handled by an access control policy’s target devices. However, the system does not log whitelist matches; logging of whitelisted connections depends on their eventual disposition.
 
    [bookmark: pgfId-1612338]When the system logs a connection event as the result of Security Intelligence filtering, it also logs a matching Security Intelligence event, which is a special kind of connection event that you can view and analyze separately. Both types of events use the Action and Reason fields to reflect the blacklist match. Additionally, so that you can identify the blacklisted IP address in the connection, host icons next to blacklisted and monitored IP addresses look slightly different in the event viewer.
 
    [bookmark: pgfId-1610212]Logging Blocked Blacklisted Connections
 
    [bookmark: pgfId-1609557]For a blocked connection, the system logs beginning-of-connection Security Intelligence and connection events. Because blacklisted traffic is immediately denied without further inspection, there is no unique end of connection to log. For these events, the action is Block and the reason is IP Block.
 
    [bookmark: pgfId-1613064]IP Block connection events have a threshold of 15 seconds per unique initiator-responder pair. That is, once the system generates an event when it blocks a connection, it does not generate another connection event for additional blocked connections between those two hosts for the next 15 seconds, regardless of port or protocol.
 
    [bookmark: pgfId-1609464]Logging Monitored Blacklisted Connections
 
    [bookmark: pgfId-1627244]For connections monitored—rather than blocked—by Security Intelligence, the system logs end-of-connection Security Intelligence and connection events to the Defense Center database. This logging occurs regardless of how the connection is later handled by an SSL policy, access control rule, or the access control default action.
 
    [bookmark: pgfId-1627248]For these connection events, the action depends on the connection’s eventual disposition. The Reason field contains IP Monitor, as well as any other reason why the connection may have been logged.
 
    [bookmark: pgfId-1615062]Note that the system may also generate beginning-of-connection events for monitored connections, depending on the logging settings in the access control rule or default action that later handles the connection.
 
    [bookmark: pgfId-1556980]To log blacklisted connections:
 
    [bookmark: pgfId-1556984]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1573004]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1573005]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1573010]The access control policy editor appears.
 
    [bookmark: pgfId-1573011]Step 3 Select the Security Intelligence tab.
 
    [bookmark: pgfId-1573012]Security Intelligence settings for the access control policy appear.
 ). 
    
 
    [bookmark: pgfId-1573295]The Blacklist Options pop-up window appears.
 
    [bookmark: pgfId-1556990]Step 5 Select the Log Connections check box.
 
    [bookmark: pgfId-1556991]Step 6 Specify where to send connection and Security Intelligence events. You have the following choices:
 
     
      
      	 [bookmark: pgfId-1556998]To send events to the Defense Center, select  Defense Center .
 
      	 [bookmark: pgfId-1556999]To send events to an external syslog server, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can add a syslog alert response by clicking the add icon (
 
     
 
     [image: ] ); see 
     Creating a Syslog Alert Response. 
    
 
     
      
      	 [bookmark: pgfId-1557006]To send connection events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can add an SNMP alert response by clicking the add icon (
 
     
 
     [image: ] ); see 
     Creating an SNMP Alert Response. 
    
 
    [bookmark: pgfId-1572330]You must send events to the Defense Center if you want to set blacklisted objects to monitor-only, or perform any other Defense Center-based analysis on connection events generated by Security Intelligence filtering. For more information, see Logging Connections to the Defense Center or External Server.
 
    [bookmark: pgfId-1573167]Step 7 Click OK to set your logging options.
 
    [bookmark: pgfId-1557014]The Security Intelligence tab appears again.
 
    [bookmark: pgfId-1557015]Step 8 Click Save.
 
   
 
    
     [bookmark: pgfId-1530800][bookmark: 80249]Logging Encrypted Connec[bookmark: marker-1583206]tions
 
    [bookmark: pgfId-1538605]License: SSL
 
    [bookmark: pgfId-1538612]Supported Devices: Series 3
 
    [bookmark: pgfId-1573508]As part of access control, the SSL inspection feature allows you to use an SSL policy to decrypt encrypted traffic for further evaluation by access control rules. You can force the system to log these decrypted connections, regardless of how the system later handles or inspects the traffic. You can also log connections when you block encrypted traffic, or when you allow it to pass to access control rules without decryption. 
 
    [bookmark: pgfId-1627953]Connection logs for encrypted sessions contain details about the encryption, such as the certificate used to encrypt that session. You configure connection logging for encrypted sessions in the SSL policy on a per-SSL rule basis so that you only log critical connections. 
 
    [bookmark: pgfId-1532401]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1532505]Logging Decryptable Connections with SSL Rules
 
     	 [bookmark: pgfId-1532506]Setting Default Logging for Encrypted and Undecryptable Connections
 
    
 
     
      [bookmark: pgfId-1585646][bookmark: 88098][bookmark: 12006]Logging Decryptable [bookmark: marker-1585645]Connections with SSL Rules
 
     [bookmark: pgfId-1585653]License: SSL
 
     [bookmark: pgfId-1585660]Supported Devices: Series 3
 
     [bookmark: pgfId-1601355]Within an SSL policy, SSL rules provide a granular method of handling encrypted traffic across multiple managed devices. So that you can log only critical connections, you enable connection logging on a per-SSL-rule basis—if you enable connection logging for a rule, the system logs all connections handled by that rule.
 
     [bookmark: pgfId-1635879]For encrypted connections inspected by an SSL policy, you can log connection events to the Defense Center database, or to an external syslog or SNMP trap server. You can log only end-of-connection events, however: 
 
      
      	 [bookmark: pgfId-1635881]for blocked connections (Block, Block with reset), the system immediately ends the session and generates an event
 
      	 [bookmark: pgfId-1601742]for monitored connections (Monitor) and connections that you pass to access control rules (Decrypt, Do not decrypt), the system generates an event when the session ends, regardless of the logging configuration of the access control rule or default action that later handles it
 
     
 
     [bookmark: pgfId-1635659]For more information, see Understanding How Access Control and SSL Rule Actions Affect Logging.
 
     [bookmark: pgfId-1585670]To log decryptable connections:
 
     [bookmark: pgfId-1585674]Access: Admin/Access Admin/Network Admin/Security Approver
 
     
 
     [bookmark: pgfId-1585675]Step 1 Select Policies > SSL.
 
     [bookmark: pgfId-1585676]The SSL Policy page appears.
 ) next to the SSL policy you want to edit. 
     
 
     [bookmark: pgfId-1601915]The SSL policy editor appears, focused on the Rules tab.
 ) next to the rule where you want to configure logging. 
     
 
     [bookmark: pgfId-1601920]The SSL rule editor appears.
 
     [bookmark: pgfId-1585684]Step 4 Select the Logging tab.
 
     [bookmark: pgfId-1585685]The Logging tab appears. 
 
     [bookmark: pgfId-1585686]Step 5 Select Log at End of Connection.
 
     [bookmark: pgfId-1585687]Step 6 Specify where to send connection events. You have the following choices:
 
      
       
       	 [bookmark: pgfId-1585694]To send connection events to the Defense Center, select  Defense Center . When your rule action is  Monitor , you must log connections to the Defense Center.
 
       	 [bookmark: pgfId-1585698]To send events to an external syslog, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can add a syslog alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating a Syslog Alert Response. 
     
 
      
       
       	 [bookmark: pgfId-1585705]To send events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can add an SNMP alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating an SNMP Alert Response. 
     
 
     [bookmark: pgfId-1601848]You must send events to the Defense Center if you want to perform Defense Center-based analysis on these connection events. For more information, see Logging Connections to the Defense Center or External Server.
 
     [bookmark: pgfId-1585713]Step 7 Click Add to save your changes. 
 
     [bookmark: pgfId-1601896]You must apply the access control policy the SSL policy is associated with for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1585715]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1532508][bookmark: 38174]Setting Default Logging for Encrypted and Undecryptable [bookmark: marker-1534064]Connections
 
     [bookmark: pgfId-1538554]License: SSL
 
     [bookmark: pgfId-1538561]Supported Devices: Series 3
 
     [bookmark: pgfId-1615199]You can log connections for the traffic handled by the default action of your SSL policy. These logging settings also govern how the system logs undecryptable sessions.
 
     [bookmark: pgfId-1615203]The SSL policy default action determines how the system handles encrypted traffic that matches none of the SSL rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic). If your SSL policy does not contain any SSL rules, the default action determines how all encrypted sessions on your network are logged. For more information, see Setting Default Handling and Inspection for Encrypted Traffic. 
 
     [bookmark: pgfId-1583842]You can configure the SSL policy default action to log connection events to the Defense Center database, or to an external syslog or SNMP trap server. You can log only end-of-connection events, however: 
 
      
      	 [bookmark: pgfId-1584000]for blocked connections (Block, Block with reset), the system immediately ends the sessions and generates an event
 
      	 [bookmark: pgfId-1584067]for connections that you allow to pass unencrypted to access control rules (Do not decrypt), the system generates an event when the session ends
 
     
 
     [bookmark: pgfId-1587281]Note that even if you disable logging for the SSL policy default action, end-of-connection events may still be logged to the Defense Center database if the connection previously matched at least one SSL Monitor rule, or later matches an access control rule or the access control policy default action.
 
     [bookmark: pgfId-1532554]To set the default handling for encrypted and undecryptable traffic:
 
     [bookmark: pgfId-1532613]Access: Admin/Access Admin/Network Admin/Security Approver
 
     
 
     [bookmark: pgfId-1602112]Step 1 Select Policies > SSL.
 
     [bookmark: pgfId-1602113]The SSL Policy page appears.
 ) next to the SSL policy you want to edit. 
     
 
     [bookmark: pgfId-1602129]The SSL policy editor appears, focused on the Rules tab.
 drop-down list. 
     
 
     [bookmark: pgfId-1532960]The Logging pop-up window appears.
 
     [bookmark: pgfId-1533058]Step 4 Select Log at End of Connection to enable logging connection events.
 
     [bookmark: pgfId-1533279]Step 5 Specify where to send connection events. You have the following choices:
 
      
       
       	 [bookmark: pgfId-1533285]To send connection events to the Defense Center, select  Defense Center .
 
       	 [bookmark: pgfId-1533287]To send events to an external syslog server, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can configure a syslog alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating a Syslog Alert Response. 
     
 
      
       
       	 [bookmark: pgfId-1533294]To send events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can configure an SNMP alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating an SNMP Alert Response. 
     
 
     [bookmark: pgfId-1585121]You must send events to the Defense Center if you want to perform Defense Center-based analysis on these connection events. However, note that traffic handled by the SSL policy default action is not further inspected for intrusions, malware, or discovery data. For more information, see Logging Connections to the Defense Center or External Server.
 
     [bookmark: pgfId-1533333]Step 6 Click OK to save your changes.
 
     [bookmark: pgfId-1533399]You must apply the access control policy the SSL policy is associated with for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1536089]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1533579][bookmark: 14699]Logging Connections Based on Access Control Handling
 
    [bookmark: pgfId-1590887]License: Any
 
    [bookmark: pgfId-1590888]Within an access control policy, access control rules provide a granular method of handling network traffic across multiple managed devices. So that you can log only critical connections, you enable connection logging on a per-access-control-rule basis—if you enable connection logging for a rule, the system logs all connections handled by that rule.
 
    [bookmark: pgfId-1588561]You can also log connections for the traffic handled by the default action of your access control policy. The default action determines how the system handles traffic that matches none of the access control rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic).
 
    [bookmark: pgfId-1588562]Note that even if you disable logging for all access control rules and the default action, end-of-connection events may still be logged to the Defense Center database if the connection matches an access control rule and contains an intrusion attempt, prohibited file, or malware, or if it was decrypted by the system and you enabled logging for the connection in the SSL policy.
 
    [bookmark: pgfId-1587839]Depending on the rule or default policy action and the associated inspection options that you configure, your logging options differ. For more information, see:
 
     
     	 [bookmark: pgfId-1579006]Logging Connections Matching an Access Control Rule
 
     	 [bookmark: pgfId-1579012]Logging Connections Handled by the Access Control Default Action
 
    
 
     
      [bookmark: pgfId-1587551][bookmark: 31190]Logging Connections Matching an Access Control Rule
 
     [bookmark: pgfId-1621507]License: Any
 
     [bookmark: pgfId-1587552]To log only critical connections, you enable connection logging on a per-access-control-rule basis. If you enable logging for a rule, the system logs all connections handled by that rule.
 
     [bookmark: pgfId-1585987]Depending on the rule action and intrusion and file inspection configuration of the rule, your logging options differ; see Understanding How Access Control and SSL Rule Actions Affect Logging. Also, note that even if you disable logging for an access control rule, end-of-connection events for connections matching that rule may still be logged to the Defense Center database if the connection: 
 
      
      	 [bookmark: pgfId-1588421]contains an intrusion attempt, prohibited file, or malware
 
      	 [bookmark: pgfId-1638240]was inspected and logged by an SSL policy
 
      	 [bookmark: pgfId-1588422]previously matched at least one access control Monitor rule
 
     
 
     [bookmark: pgfId-1588424]To configure an access control rule to log connection, file, and malware information:
 
     [bookmark: pgfId-1574144]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1574145]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1574146]The Access Control Policy page appears.
 ) next to the access control policy you want to modify. 
     
 
     [bookmark: pgfId-1574151]The access control policy editor appears, focused on the Rules tab.
 ) next to the rule where you want to configure logging. 
     
 
     [bookmark: pgfId-1574153]The access control rule editor appears.
 
     [bookmark: pgfId-1574154]Step 4 Select the Logging tab.
 
     [bookmark: pgfId-1574155]The Logging tab appears.
 
     [bookmark: pgfId-1574160]Step 5 Specify whether you want to Log at Beginning of Connection or Log at End of Connection.
 
     [bookmark: pgfId-1575665]To optimize performance, log either the beginning or the end of any connection, but not both. 
 
     [bookmark: pgfId-1575897]For a single non-blocked connection, the end-of-connection event contains all of the information in the beginning-of-connection event, as well as information gathered over the duration of the session. Because blocked traffic is immediately denied without further inspection, you can log only beginning-of-connection events for Block rules. 
 
     [bookmark: pgfId-1575918]Also note that because the purpose of a Monitor rule is to log matching traffic, end-of-connection logging to the Defense Center database is auto-enabled and you cannot disable it. For more information, see Logging the Beginning or End of Connections.
 
     [bookmark: pgfId-1575666]Step 6 Use the Log Files check box to specify whether the system should log any file and malware events associated with the connection.
 
     [bookmark: pgfId-1582232]The system automatically enables this option when you associate a file policy with the rule to perform either file control or AMP. Cisco recommends you leave this option enabled; see Disabling File and Malware Event Logging for Allowed Connections. 
 
     [bookmark: pgfId-1574167]Step 7 Specify where to send connection events. You have the following choices:
 
      
       
       	 [bookmark: pgfId-1604137]To send connection events to the Defense Center, select  Defense Center . You cannot disable this option for Monitor rules.
 
       	 [bookmark: pgfId-1574178]To send events to an external syslog server, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can add a syslog alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating a Syslog Alert Response. 
     
 
      
       
       	 [bookmark: pgfId-1576047]To send events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can add an SNMP alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating an SNMP Alert Response. 
     
 
     [bookmark: pgfId-1576113]You must send events to the database if you want to perform Defense Center-based analysis on connection events. For more information, see Logging Connections to the Defense Center or External Server.
 
     [bookmark: pgfId-1576055]Step 8 Click Save to save the rule. 
 
     [bookmark: pgfId-1576214]Your rule is saved. You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1576614]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1576616][bookmark: 10479]Logging Conn[bookmark: marker-1576618]ections Handled by the Access Control Default Action
 
     [bookmark: pgfId-1576624]License: Any
 
     [bookmark: pgfId-1577766]You can log connections for the traffic handled by the default action of your access control policy. The default action determines how the system handles traffic that matches none of the access control rules in the policy (except Monitor rules, which match and log—but do not handle or inspect—traffic); see Setting Default Handling and Inspection for Network Traffic.
 
      
       
        
        [bookmark: pgfId-1578550]Table 38-4 Access Control Default Action Logging Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1578556]Default Action 
          
  
         	 
           
           [bookmark: pgfId-1578558]Compare To 
          
  
         	 
           
           [bookmark: pgfId-1578560]See... 
          
  
        
 
         
         	[bookmark: pgfId-1578562]Access Control: Block All Traffic
  
         	[bookmark: pgfId-1578564]Block rules
  
         	[bookmark: pgfId-1578568]Understanding Logging for Blocked and Interactively Blocked Connections
  
        
 
         
         	[bookmark: pgfId-1578571]Access Control: Trust All Traffic
  
         	[bookmark: pgfId-1578573]Trust rules
  
         	[bookmark: pgfId-1578577]Understanding Logging for Trusted Connections
  
        
 
         
         	[bookmark: pgfId-1578580]Intrusion Prevention
  
         	[bookmark: pgfId-1578582]Allow rules with associated intrusion policies
  
         	 [bookmark: pgfId-1578586]Understanding Logging for Allowed Connections
  
        
 
         
         	[bookmark: pgfId-1578589]Network Discovery Only
  
         	[bookmark: pgfId-1578591]Allow rules without associated intrusion policies
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1577636]However, there are some differences between logging connections handled by access control rules versus the default action:
 
      
      	 [bookmark: pgfId-1576519]The default action has no file logging options. You cannot perform file control or AMP using the default action.
 
      	 [bookmark: pgfId-1576520]When an intrusion policy associated with the access control default action generates an intrusion event, the system does  not automatically log the end of the associated connection. This is useful for intrusion detection and prevention-only deployments, where you do not want to log any connection data. 
 
     
 
     [bookmark: pgfId-1576521]An exception to this rule occurs if you enable beginning-of-connection logging for the default action. In that case, the system does log the end of the connection when an associated intrusion policy triggers, in addition to logging the beginning of the connection. 
 
     [bookmark: pgfId-1586989]Note that even if you disable logging for the default action, end-of-connection events for connections matching that rule may still be logged to the Defense Center database if the connection previously matched at least one access control Monitor rule, or was inspected and logged by an SSL policy.
 
     [bookmark: pgfId-1576538]To log connections in traffic handled by the access control default action:
 
     [bookmark: pgfId-1576542]Access: Admin/Access Admin/Network Admin
 
     
 
     [bookmark: pgfId-1576363]Step 1 Select Policies > Access Control.
 
     [bookmark: pgfId-1576364]The Access Control Policy page appears.
 ) next to the access control policy you want to modify. 
     
 
     [bookmark: pgfId-1576369]The access control policy editor appears, focused on the Rules tab.
 drop-down list. 
     
 
     [bookmark: pgfId-1576448]The Logging pop-up window appears.
 
     [bookmark: pgfId-1576449]Step 4 Specify whether you want to Log at Beginning of Connection or Log at End of Connection.
 
     [bookmark: pgfId-1579831]To optimize performance, log either the beginning or the end of these connections, but not both. For a single non-blocked connection, the end-of-connection event contains all of the information in the beginning-of-connection event, as well as information gathered over the duration of the session. Because blocked traffic is immediately denied without further inspection, you can log only beginning-of-connection events for the Block All Traffic default action. 
 
     [bookmark: pgfId-1576451]Step 5 Specify where to send connection events. You have the following choices:
 
      
       
       	 [bookmark: pgfId-1577526]To send connection events to the Defense Center, select  Defense Center . You cannot disable this option for Monitor rules.
 
       	 [bookmark: pgfId-1577530]To send events to an external syslog server, select  Syslog , then select a syslog alert response from the drop-down list. Optionally, you can add a syslog alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating a Syslog Alert Response. 
     
 
      
       
       	 [bookmark: pgfId-1577537]To send events to an SNMP trap server, select  SNMP Trap , then select an SNMP alert response from the drop-down list. Optionally, you can add an SNMP alert response by clicking the add icon (
 
      
 
      [image: ] ); see 
      Creating an SNMP Alert Response. 
     
 
     [bookmark: pgfId-1577547]You must send events to the database if you want to perform Defense Center-based analysis on connection events. For more information, see Logging Connections to the Defense Center or External Server.
 
     [bookmark: pgfId-1579685]Step 6 Click Save to save the policy.
 
     [bookmark: pgfId-1579688]Your policy is saved. You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
     [bookmark: pgfId-1530975]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1544536][bookmark: 26694]Logging URLs Detected in Connections
 
    [bookmark: pgfId-1544543]License: FireSIGHT
 
    [bookmark: pgfId-1544549]When you log an end-of-connection event to the Defense Center database for HTTP traffic, the system records the URL requested by the monitored host during the session.
 
    [bookmark: pgfId-1544551]By default, the system stores the first 1024 characters of the URL in the connection log. However, you can configure the system to store up to 4096 characters per URL to make sure you capture the full URLs requested by monitored hosts. Or, if you are uninterested in the individual URLs visited, you can disable URL storage entirely by storing zero characters. Depending on your network traffic, disabling or limiting the number of stored URL characters may improve system performance.
 
    [bookmark: pgfId-1544552]Note that disabling URL logging does not affect URL filtering. Access control rules properly filter traffic based on requested URLs, their categories, and reputations, even though the system does not record the individual URLs requested in the traffic handled by those rules. For more information, see Blocking URLs.
 
    [bookmark: pgfId-1544553]To customize the number of URL characters you store:
 
    [bookmark: pgfId-1544557]Access: Admin/Access Admin/Network Admin
 
    
 
    [bookmark: pgfId-1544558]Step 1 Select Policies > Access Control.
 
    [bookmark: pgfId-1635379]The Access Control Policy page appears.
 ) next to the access control policy you want to configure. 
    
 
    [bookmark: pgfId-1635384]The access control policy editor appears.
 
    [bookmark: pgfId-1544565]Step 3 Select the Advanced tab. 
 
    [bookmark: pgfId-1544566]Advanced settings for the access control policy appear. 
 ) next to General Settings. 
    
 
    [bookmark: pgfId-1544571]The General Settings pop-up window appears.
 
    [bookmark: pgfId-1544572]Step 5 Type the Maximum URL characters to store in connection events.
 
    [bookmark: pgfId-1544573]You can specify any number from zero to 4096. Storing zero characters disables URL storage without disabling URL filtering.
 
    [bookmark: pgfId-1544574]Step 6 Click OK.
 
    [bookmark: pgfId-1544575]Advanced settings for the access control policy appear.
 
    [bookmark: pgfId-1580130]Step 7 Click Save to save the policy.
 
    [bookmark: pgfId-1580131]Your policy is saved. You must apply the access control policy for your changes to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-1580135]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1530828]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1539037][bookmark: 25506]Working with Con[bookmark: marker-1673114]nection & Security Intelligence Data 
      
      
 
     
 
 
    [bookmark: pgfId-1925571]As managed devices monitor traffic generated by the hosts on your network, they can generate logs of the connections they detect. Various settings in access control and SSL policies give you granular control over which connections you log, when you log them, and where you store the data. In most cases, you can log a connection at its beginning or its end, or both. 
 
    [bookmark: pgfId-1931168]When you log a connection, the system generates a connection event. You can also log a special kind of connection event, called a Security Intelligence event, whenever a connection is blacklisted (blocked) or monitored by the reputation-based Security Intelligence feature. 
 
    [bookmark: pgfId-1925718]Connection logs, called connection events, contain data about the detected sessions. You should log connections according to the security and compliance needs of your organization; you can log any connection except those that are fast-pathed at the device level before they reach access control. 
 
    [bookmark: pgfId-1931876]In addition to the logging that you configure, the system automatically logs most connections where the system detects a prohibited file, malware, or intrusion attempt. Unless you disable connection event storage entirely, the system saves these end-of-connection events to the Defense Center database for further analysis. For detailed information on configuring connection logging, see Logging Connections in Network Traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-1970778]Note Although you can log connections using any appliance and license, the information available for any individual connection or Security Intelligence event depends on several factors, including licenses. For more information, see License and Model Requirements for Connection Logging.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1925021]To supplement the connection data gathered by your managed devices, you can use records generated by NetFlow-enabled devices to generate connection events. This is especially useful if you have NetFlow-enabled devices deployed on networks that your FireSIGHT System managed devices cannot monitor.
 
     
      
    
 
    
 
    [bookmark: pgfId-1925039]Note Because NetFlow data collection is not linked to access control, you do not have granular control over which NetFlow connections you want to log. FireSIGHT System managed devices detect records exported by NetFlow-enabled devices, generate unidirectional end-of-connection events based on the data in those records, and finally send those events to the Defense Center to be logged in the database. NetFlow records cannot generate Security Intelligence events, nor be logged to an external server. For more information, see Understanding NetFlow.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1580685]For more information on working with connection and Security Intelligence events, see:
 
     
     	 [bookmark: pgfId-1564595]Understanding Connection and Security Intelligence Data
 
     	 [bookmark: pgfId-1564599]Viewing Connection and Security Intelligence Data
 
     	 [bookmark: pgfId-1564604]Working with Connection Graphs
 
     	 [bookmark: pgfId-1552600]Working with Connection and Security Intelligence Data Tables
 
     	 [bookmark: pgfId-1552619]Searching for Connection and Security Intelligence Data
 
     	 [bookmark: pgfId-1674536]Viewing the Connection Summary Page
 
    
 
   
 
    
     [bookmark: pgfId-1538389][bookmark: 14270]Understanding Connection and Security Intelligence Data
 
    [bookmark: pgfId-1609887]License: Any
 
    [bookmark: pgfId-1925837]Connection logs, called connection events, contain data about the detected sessions. The information available for any individual connection event depends on several factors, but in general includes:
 
     
     	 [bookmark: pgfId-1925838]basic connection properties: timestamp, source and destination IP address, ingress and egress zones, the device that handled the connection, and so on
 
     	 [bookmark: pgfId-1925839]additional connection properties discovered or inferred by the system: applications, requested URLs, or users associated with the connection, and so on
 
     	 [bookmark: pgfId-1925840]metadata about why the connection was logged: which access control rule (or other configuration) in which policy handled the traffic, whether the connection was allowed or blocked, details about encrypted and decrypted connections, and so on
 
    
 
    [bookmark: pgfId-1943320]Various settings in access control and SSL policies give you granular control over which connections you log, when you log them, and where you store the data. You can log any connection that your access control and SSL policies can successfully handle, which may require specific appliance models or licensed capabilities. You can enable connection logging in the following situations:
 
     
     	 [bookmark: pgfId-1943009]when a connection is blacklisted (blocked) or monitored by the reputation-based Security Intelligence feature
 
     	 [bookmark: pgfId-1943013]when an encrypted session is handled by an SSL policy
 
     	 [bookmark: pgfId-1943104]when a connection is handled by an access control rule or the access control default action
 
    
 
    [bookmark: pgfId-1946597]In addition to the logging that you configure, the system automatically logs most connections where the system detects a prohibited file, malware, or intrusion attempt. Unless you disable connection event storage entirely using the system policy, regardless of your other logging configurations, the system saves these end-of-connection events to the Defense Center database for further analysis. 
 
    [bookmark: pgfId-1946828]Also, when you enable Security Intelligence logging, blacklist matches automatically generate Security Intelligence events as well as connection events. A Security Intelligence event is a special kind of connection event that you can view and analyze separately, and that is also stored and pruned separately. For detailed information on configuring connection logging, including Security Intelligence blacklisting decisions, see Logging Connections in Network Traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-1946829]Tip General information about connection events also pertains to Security Intelligence events, unless otherwise noted. For more information on Security Intelligence, see Blacklisting Using Security Intelligence IP Address Reputation.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1776529]The following sections provide additional details on the kinds of information available about detected connections:
 
     
     	 [bookmark: pgfId-1548340]Understanding Connection Summaries
 
     	 [bookmark: pgfId-1697975]Understanding Connection and Security Intelligence Data Fields
 
     	 [bookmark: pgfId-1697984]Information Available in Connection and Security Intelligence Events
 
    
 
     
      [bookmark: pgfId-1543980][bookmark: 10451]Understanding Conne[bookmark: marker-1673129]ction Summaries
 
     [bookmark: pgfId-1609926]License: Any
 
     [bookmark: pgfId-1547678]The FireSIGHT System aggregates connection data collected over five-minute intervals into connection summaries, which the system uses to generate connection graphs and traffic profiles. Optionally, you can create custom workflows based on connection summary data, which you use in the same way as you use workflows based on individual connection events. 
 
     [bookmark: pgfId-1821720]Note that there are no connection summaries specifically for Security Intelligence events, although corresponding end-of-connection events can be aggregated into connection summary data.
 
     [bookmark: pgfId-1547679]To be aggregated, multiple connections must:
 
      
      	 [bookmark: pgfId-1547680]represent the end of connections
 
      	 [bookmark: pgfId-1616751]have the same source and destination IP addresses, and use the same port on the responder (destination) host
 
      	 [bookmark: pgfId-1547682]use the same protocol (TCP or UDP)
 
      	 [bookmark: pgfId-1547683]use the same application protocol
 
      	 [bookmark: pgfId-1547688]either be detected by the same Cisco managed device, or be exported by the same NetFlow-enabled device
 
     
 
     [bookmark: pgfId-1547689]Each connection summary includes total traffic statistics, as well as the number of connections in the summary. Because NetFlow-enabled devices generate unidirectional connections, a summary’s connection count is incremented by two for every connection based on NetFlow data.
 
     [bookmark: pgfId-1565575]Note that connection summaries do not contain all of the information associated with the summaries’ aggregated connections. For example, because client information is not used to aggregate connections into connection summaries, summaries do not contain client information. 
 
     [bookmark: pgfId-1616804]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1616808]Long-Running Connections
 
      	 [bookmark: pgfId-1616812]Combined Connection Summaries from External Responders
 
      	 [bookmark: pgfId-1565556]Information Available in Connection and Security Intelligence Events
 
     
 
    
 
     
      [bookmark: pgfId-1547695][bookmark: 14847]Long-Running Connections
 
     [bookmark: pgfId-1609939]License: Any
 
     [bookmark: pgfId-1547696]If a monitored session spans two or more five-minute intervals over which connection data is aggregated, the connection is considered a long-running connection. When calculating the number of connections in a connection summary, the system increments the count only for the five-minute interval in which a long-running connection was initiated.
 
     [bookmark: pgfId-1548681]Also, when calculating the number of packets and bytes transmitted by the initiator and responder in a long-running connection, the system does not report the number of packets and bytes that were actually transmitted during each five-minute interval. Instead, the system assumes a constant rate of transmission and calculates estimated figures based on the total number of packets and bytes transmitted, the length of the connection, and what portion of the connection occurred during each five-minute interval.
 
    
 
     
      [bookmark: pgfId-1548678][bookmark: 78157]Combined Connection Summaries from External [bookmark: marker-1548677]Responders
 
     [bookmark: pgfId-1609952]License: Any
 
     [bookmark: pgfId-1547701]To reduce the space required to store connection data and speed up the rendering of connection graphs, the system combines connection summaries when:
 
      
      	 [bookmark: pgfId-1549677]one of the hosts involved in the connection is not on your monitored network 
 
      	 [bookmark: pgfId-1549691]other than the IP address of the external host, the connections in the summaries meet the aggregation criteria listed in Understanding Connection Summaries: protocol, application protocol, detecting device, and so on
 
     
 
     [bookmark: pgfId-1548761]When viewing connection summaries in the event viewer and when working with connection graphs, the system displays external instead of an IP address for the non-monitored hosts.
 
     [bookmark: pgfId-1547703]As a consequence of this aggregation, if you attempt to drill down to the table view of connection data (that is, access data on individual connections) from a connection summary or graph that involves an external responder, the table view contains no information.
 
    
 
     
      [bookmark: pgfId-1697091][bookmark: 55717]Understanding Connection and Security Inte[bookmark: marker-1835882]lligence Data[bookmark: marker-1776860] Fields
 
     [bookmark: pgfId-1709373]License: feature dependent
 
     [bookmark: pgfId-1827737]Supported Devices: feature dependent
 
     [bookmark: pgfId-1827767]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1849675]Each connection table view or connection graph contains information about the connections or connection summaries you are viewing, including timestamps, IP addresses, geolocation information, applications, and so on. Security Intelligence event views contain the same general information as connection event views, but list only connections with assigned Security Intelligence Category values.
 
      
       
     
 
     
 
     [bookmark: pgfId-1971674]Note The information available for any individual connection or Security Intelligence event depends on several factors, including licenses and appliance model. For more information, see License and Model Requirements for Connection Logging.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1814070]The following list details the connection data logged by the FireSIGHT System. For a discussion of the factors that determine the information logged in any individual connection or Security Intelligence event, see the next section: Information Available in Connection and Security Intelligence Events.
 
     [bookmark: pgfId-1816569]Access Control Policy
 
     [bookmark: pgfId-1816570]The access control policy that monitored the connection.
 
     [bookmark: pgfId-1816630]Access Control Rule
 
     [bookmark: pgfId-1816631]The access control rule or default action that handled the connection, as well as up to eight Monitor rules matched by that connection.
 
     [bookmark: pgfId-1816636]If the connection matched one Mo[bookmark: marker-1816632]nitor rule, the Defense Center displays the name of the rule that handled the connection, followed by the Monitor rule name. If the connection matched more than one Monitor rule, the event viewer displays how many Monitor rules it matched, for example, Default Action + 2 Monitor Rules.
 
     [bookmark: pgfId-1816641]To display a pop-up window with a list of the first eight Monitor rules matched by the connection, click N Monitor Rules.
 
     [bookmark: pgfId-1816565][bookmark: 61050]Action
 
     [bookmark: pgfId-1815186]The action associated with the access control rule or default action that logged the connection:
 
     [bookmark: pgfId-1815187] – Allow represents explicitly allowed and user-bypassed interactively blocked connections.
 
     [bookmark: pgfId-1815188] – Trust represents trusted connections. Note that the system logs TCP connections detected by a trust rule differently depending on the appliance.
 
     [bookmark: pgfId-1815192]On Series 2, virtual devices, and Cisco NGIPS for Blue Coat X-Series, TCP connections detected by a trust rule on the first packet only generate an end-of-connection event. The system generates the event one hour after the final session packet.
 
     [bookmark: pgfId-1815196]On Series 3 appliances, TCP connections detected by a trust rule on the first packet generate different events depending on the presence of a monitor rule. If the monitor rule is active, the system evaluates the packet and generates both a beginning and end-of-connection event. If no monitor rule is active, the system only generates an end-of-connection event.
 
     [bookmark: pgfId-1815197] – Block and Block with reset represent blocked connections. The system also associates the Block action with connections blacklisted by Securit[bookmark: marker-1815198]y Intelligence, connections blocked by an SSL policy, connections where an exploit was detected by an intrusion policy, and connections where a file was blocked by a file policy.
 
     [bookmark: pgfId-1815199] – Interactive Block and Interactive Block with reset mark the beginning-of-connection event that you can log when the system initially blocks a user’s HTTP request using an Interactive Block rule. If the user clicks through the warning page that the system displays, any additional connection events you log for the session have an action of Allow.
 
     [bookmark: pgfId-1815200] – Default Action indicates the connection was handled by the default action.
 
     [bookmark: pgfId-1815201] – For Security Intelligence-monitored connections, the action is that of the first non-Monitor access control rule triggered by the connection, or the default action. Similarly, because traffic matching a Monitor rule is always handled by a subsequent rule or by the default action, the action associated with a connection logged due to a monitor rule is never Monitor.
 
     [bookmark: pgfId-1815854]Application Protocol
 
     [bookmark: pgfId-1815855]The application protocol, which represents communications between hosts, detected in the connection.
 
     [bookmark: pgfId-1815954]Application Risk
 
     [bookmark: pgfId-1921095]The risk associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated risk; this field displays the highest of those. For more information, see Table 45-2.
 
     [bookmark: pgfId-1921099]Business Relevance
 
     [bookmark: pgfId-1815994]The business relevance associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated business relevance; this field displays the lowest (least relevant) of those. For more information, see Table 45-2.
 
     [bookmark: pgfId-1815923]Category, Tag (Application Protocol, Client, Web Application)
 
     [bookmark: pgfId-1815924]Criteria that characterize the application to help you understand the application's function. For more information, see Table 45-2.
 
     [bookmark: pgfId-1815886]Client and Client Version
 
     [bookmark: pgfId-1815887]The client application and version of that client detected in the connection.
 
     [bookmark: pgfId-1815888]If the system cannot identify the specific client used in the connection, this field displays client appended to the application protocol name to provide a generic name, for example, FTP client.
 
     [bookmark: pgfId-1817511]Connections
 
     [bookmark: pgfId-1817512]The number of connections in a connection summary. For long-running connections, that is, connections that span multiple connection summary intervals, only the first connection summary interval is incremented.
 
     [bookmark: pgfId-1817552]Count
 
     [bookmark: pgfId-1817553]The number of connections that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
      
       
     
 
     
 
     [bookmark: pgfId-1817554]Note If you create a custom workflow and do not add the Count column to a drill-down page, each connection is listed individually and packets and bytes are not summed.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1816833]Device
 
     [bookmark: pgfId-1816834]The managed device that detected the connection or, for connections exported by NetFlow-enabled devices, the managed device that processed the NetFlow data.
 
     [bookmark: pgfId-1816413]Files
 ) in this field. The number on the icon indicates the number of files (including malware files) detected or blocked in that connection. 
     
 
     [bookmark: pgfId-1816421]Click the icon to display a pop-up window with a list of the files detected in the connection, as well as their types and if applicable, their malware lookup dispositions.
 
     [bookmark: pgfId-1816432]Note that neither the DC500 Defense Center nor Series 2 devices support network-based malware file detection.
 
     [bookmark: pgfId-1816435]For more information, see Viewing Files Detected in a Connection.
 
     [bookmark: pgfId-1814843]First Packet or Last Packet
 
     [bookmark: pgfId-1698404]The date and time the first or last packet of the session was seen.
 
     [bookmark: pgfId-1916206]HTTP Referrer
 
     [bookmark: pgfId-1916207]The HTTP referrer, which represents the referrer of a requested URL for HTTP traffic detected in the connection (such as a website that provided a link to, or imported a link from, another URL).
 
     [bookmark: pgfId-1816873]Ingress Interface or Egress Interface
 
     [bookmark: pgfId-1816874]The ingress or egress interface associated with the connection. Note that, if your deployment includes an asynchronous routing configuration, the ingress and egress interface may belong to the same interface set.
 
     [bookmark: pgfId-1815794]Ingress Security Zone or Egress Security Zone
 
     [bookmark: pgfId-1815795]The ingress or egress security zone associated with the connection.
 
     [bookmark: pgfId-1817122]Initiator Bytes or Responder Bytes
 
     [bookmark: pgfId-1817123]The total number of bytes transmitted by the session initiator or the session responder.
 
     [bookmark: pgfId-1815489]Initiator Country or Responder Country
 
     [bookmark: pgfId-1815490]When a routable IP is detected, the country associated with the host IP address that initiated the session, or with the session responder. An icon of the country’s flag is displayed, as well as the country’s ISO 3166-1 alpha-3 country code. Hover your pointer over the flag icon to view the country’s full name.
 
     [bookmark: pgfId-1815494]Note that the DC500 Defense Center does not support this feature.
 
     [bookmark: pgfId-1815390]Initiator IP or Responder IP
 
     [bookmark: pgfId-1815391]The host IP address (and host name, if DNS resolution is enabled) that initiated, or responded to, the session responder. So that you can identify the blacklisted IP address in a blacklisted connection, host icons next to blacklisted IP addresses look slightly different.
 
     [bookmark: pgfId-1817094]Initiator Packets or Responder Packets
 
     [bookmark: pgfId-1817095]The total number of packets transmitted by the session initiator or the session responder.
 
     [bookmark: pgfId-1815582]Initiator User
 
     [bookmark: pgfId-1815583]The user logged into the session initiator.
 
     [bookmark: pgfId-1816254]Intru[bookmark: marker-1816253]sion Events
 ) in this field. 
     
 
     [bookmark: pgfId-1816262]Click the icon to display a pop-up window with a list of intrusion events associated with the connection, as well as their priority and impact. For more information, see Viewing Intrusion Events Associated with a Connection.
 
     [bookmark: pgfId-1817687]IOC
 
     [bookmark: pgfId-1817736]Whether or not the event triggered an indication of compromise (IOC) against a host involved in the connection. For more information on IOC, see Understanding Indications of Compromise.
 
     [bookmark: pgfId-1816960]NetBIOS Domain
 
     [bookmark: pgfId-1816961]The NetBIOS domain used in the session.
 
     [bookmark: pgfId-1818296]NetFlow Destination/Source Autonomous System
 
     [bookmark: pgfId-1818375][bookmark: marker-1836568]For connections exported by NetFlow-enabled devices, the border gateway protocol autonomous system number for the source or destination of traffic in the connection.
 
     [bookmark: pgfId-1818399]NetFlow Destination/Source Prefix
 
     [bookmark: pgfId-1818434]For connections exported by NetFlow-enabled devices, the source or destination IP address ANDed with the source or destination prefix mask.
 
     [bookmark: pgfId-1818449]NetFlow Destination/Source TOS
 
     [bookmark: pgfId-1818481]For connections exported by NetFlow-enabled devices, the setting for the type-of-service (TOS) byte when connection traffic entered or exited the NetFlow-enabled device.
 
     [bookmark: pgfId-1818496]NetFlow SNMP Input/Output
 
     [bookmark: pgfId-1818603]For connections exported by NetFlow-enabled devices, the interface index for the interface where connection traffic entered or exited the NetFlow-enabled device.
 
     [bookmark: pgfId-1981997]Network Analysis Policy
 
     [bookmark: pgfId-1981993]The network analysis policy (NAP), if any, associated with the generation of the event.
 
     [bookmark: pgfId-1743100][bookmark: 37079]Reason
 
     [bookmark: pgfId-1698414]The reason or reasons the connection was logged, in the following situations:
 
     [bookmark: pgfId-1698415] – User Bypass indicates that the system initially blocked a user’s HTTP request, but the user chose to continue to the originally requested site by clicking through a warning page. A reason of User Bypass is always paired with an action of Allow.
 
     [bookmark: pgfId-1711707] – IP Block indicates that the system denied the connection without inspection, based on Security Intelligence data. A reason of IP Block is always paired with an action of Block.
 
     [bookmark: pgfId-1711708] – IP Monitor indicates that the system would have denied the connection based on Security Intelligence data, but you configured the system to monitor, rather than deny, the connection.
 
     [bookmark: pgfId-1808097] – File Monitor indicates that the system detected a particular type of file in the connection.
 
     [bookmark: pgfId-1808098] – File Block indicates the connection contained a file or malware file that the system prevented from being transmitted. A reason of File Block is always paired with an action of Block.
 
     [bookmark: pgfId-1811082] – File Custom Detection indicates the connection contained a file on the custom detection list that the system prevented from being transmitted. 
 
     [bookmark: pgfId-1811076] – File Resume Allow indicates that file transmission was originally blocked by a Block Files or Block Malware file rule. After a new access control policy was applied that allowed the file, the HTTP session automatically resumed. Note that this reason only appears in inline deployments.
 
     [bookmark: pgfId-1811747] – File Resume Block indicates that file transmission was originally allowed by a Detect Files or Malware Cloud Lookup file rule. After a new access control policy was applied that blocked the file, the HTTP session automatically stopped. Note that this reason only appears in inline deployments.
 
     [bookmark: pgfId-1916212] – SSL Block indicates the system blocked an encrypted connection based on the SSL inspection configuration. A reason of SSL Block is always paired with an action of Block.
 
     [bookmark: pgfId-1811077] – Intrusion Block indicates the system blocked or would have blocked an exploit (intrusion policy violation) detected in the connection. A reason of Intrusion Block is paired with an action of Block for blocked exploits and Allow for would-have-blocked exploits.
 
     [bookmark: pgfId-1890551] – Intrusion Monitor indicates the system detected, but did not block, an exploit detected in the connection. This occurs when the state of the triggered intrusion rule is set to Generate Events.
 
     [bookmark: pgfId-1916217]Referenced Host
 
     [bookmark: pgfId-1916218]If the protocol in the connection is DNS, HTTP, or HTTPS, this field displays the host name that the respective protocol was using.
 
     [bookmark: pgfId-1891016]Security Context
 
     [bookmark: pgfId-1891017]The metadata identifying the virtual firewall group through which the traffic passed. Note that the system only populates this field for ASA FirePOWER devices in multiple context mode.
 
     [bookmark: pgfId-1857453]Security Intelligence Category
 
     [bookmark: pgfId-1815698]The name of the blacklisted object that represents or contains the blacklisted IP address in the connection. The Security Intelligence category can be the name of a network object or group, the global blacklist, a custom Security Intelligence list or feed, or one of the categories in the Intelligence Feed. Note that this field is only populated if the Reason is IP Block or IP Monitor; entries in Security Intelligence event views always display a reason. For more information, see Blacklisting Using Security Intelligence IP Address Reputation.
 
     [bookmark: pgfId-1815711]Note also that neither the DC500 Defense Center nor Series 2 devices support this feature.
 
     [bookmark: pgfId-1816933]Source Device
 
     [bookmark: pgfId-1816934]The IP address of the NetFlow-enabled device that exported the data for the connection. If the connection was detected by a managed device, this field contains a value of FireSIGHT.
 
     [bookmark: pgfId-1815826]Source Port/ICMP Type or Destination Port/ICMP Code
 
     [bookmark: pgfId-1815827]The port, ICMP type, or ICMP code used by the session initiator or session responder.
 
     [bookmark: pgfId-1916223]SSL Status
 
     [bookmark: pgfId-1916224]The action associated with the SSL rule, default action, or undecryptable traffic action that logged the encrypted connection:
 
     [bookmark: pgfId-1916225] – Block and Block with reset represent blocked encrypted connections. 
 
     [bookmark: pgfId-1916226] – Decrypt (Resign) represents an outgoing connection decrypted using a re-signed server certificate. 
 
     [bookmark: pgfId-1916227] – Decrypt (Replace Key) represents an outgoing connection decrypted using a self-signed server certificate with a substituted public key.
 
     [bookmark: pgfId-1916228] – Decrypt (Known Key) represents an incoming connection decrypted using a known private key.
 
     [bookmark: pgfId-1916229] – Do not Decrypt represents a connection the system did not decrypt.
 
     [bookmark: pgfId-1916230]If the system fails to decrypt an encrypted connection, it displays the undecryptable traffic action taken, as well as the failure reason. For example, if the system detects traffic encrypted with an unknown cipher suite and allows it without further inspection, this field displays Do Not Decrypt (Unknown Cipher Suite).
 ) to view certificate details. For more information, see 
     Viewing the Certificate Associated with an Encrypted Connection. 
     
 
     [bookmark: pgfId-1916239]SSL Certificate Status
 
     [bookmark: pgfId-1916240]If encrypted traffic matches an SSL rule, this field displays the server certificate statuses. If undecryptable traffic matches an SSL rule, this displays Not Checked. For more information, see Controlling Encrypted Traffic by Certificate Status.
 
     [bookmark: pgfId-1956521]SSL Flow Error
 
     [bookmark: pgfId-1956522]The error name and hexadecimal code if an error occurred during the SSL session; Success if no error occurred. 
 
     [bookmark: pgfId-1956523]SSL Version
 
     [bookmark: pgfId-1916245]The SSL or TLS protocol version used to encrypt the connection.
 
     [bookmark: pgfId-1942635]SSL Cipher Suite
 
     [bookmark: pgfId-1942636]The cipher suite used to encrypt the connection.
 
     [bookmark: pgfId-1916246]SSL Policy
 
     [bookmark: pgfId-1916247]The SSL policy that handled the connection.
 
     [bookmark: pgfId-1916248]SSL Rule
 
     [bookmark: pgfId-1916249]The SSL rule or default action that handled the connection, as well as the first Monitor rule matched by that connection. If the connection matched a Mo[bookmark: marker-1916250]nitor rule, the Defense Center displays the name of the rule that handled the connection, followed by the Monitor rule name.
 
     [bookmark: pgfId-1956629]SSL Session ID
 
     [bookmark: pgfId-1956630]The hexadecimal Session ID negotiated between the client and server during the SSL handshake. 
 
     [bookmark: pgfId-1956631]SSL Ticket ID
 
     [bookmark: pgfId-1956564]A hexadecimal hash value of the session ticket information sent during the SSL handshake.
 
     [bookmark: pgfId-1956565]SSL Flow Flags
 
     [bookmark: pgfId-1916257]The first ten debugging level flags for an encrypted connection. To view all flags, click the ellipsis (...).
 
     [bookmark: pgfId-1916258]SSL Flow Messages
 
     [bookmark: pgfId-1916259]The messages exchanged between client and server during the SSL handshake. See http://tools.ietf.org/html/rfc5246 for more information.
 
     [bookmark: pgfId-1816901]TCP Flags
 
     [bookmark: pgfId-1816902]The TCP flags detected in the connection.
 
     [bookmark: pgfId-1815693][bookmark: 34313]Time
 
     [bookmark: pgfId-1815343]The ending time of the five-minute interval that the system used to aggregate connections in a connection summary.
 
     [bookmark: pgfId-1816136]URL, URL Category, and URL Reputation
 
     [bookmark: pgfId-1921454]The URL requested by the monitored host during the session and its associated category and reputation, if available. 
 
     [bookmark: pgfId-1921455]If the system identifies or blocks an SSL application, the requested URL is in encrypted traffic, so the system identifies the traffic based on an SSL certificate. For SSL applications, therefore, this field indicates the common name contained in the certificate.
 
     [bookmark: pgfId-1816151]Note that neither the DC500 Defense Center nor Series 2 devices support URL category or reputation data.
 
     [bookmark: pgfId-1916265]User Agent
 
     [bookmark: pgfId-1916266]User agent application information extracted from HTTP traffic detected in the connection.
 
     [bookmark: pgfId-1698445]Web Application
 
     [bookmark: pgfId-1698447]The web application, which represents the content or requested URL for HTTP traffic detected in the connection. 
 
     [bookmark: pgfId-1830138]If the web application does not match the URL for the event, the traffic is probably referred traffic, such as advertisement traffic. If the system detects referred traffic, it stores the referring application (if available) and lists that application as the web application. 
 
     [bookmark: pgfId-1828063]Supported Devices: feature dependent
 
     [bookmark: pgfId-1828067]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1849709]The information available for any individual connection, connection summary, or Security Intelligence event depends on several factors.
 
     [bookmark: pgfId-1948412]Appliance Model and License
 
     [bookmark: pgfId-1948413]You can log any connection that your access control and SSL policies can successfully handle. However, many features require that you enable specific licensed capabilities on target devices, and many features are only available on some models. 
 
     [bookmark: pgfId-1948423]For example, SSL inspection requires a Series 3 device. Other appliance models cannot inspect encrypted traffic; logged connection events do not contain information about encrypted connections. As another example, you cannot view geolocation data in connection events using a DC500. For more information, see License and Model Requirements for Connection Logging. 
 
     [bookmark: pgfId-1948973]Traffic Characteristics
 
     [bookmark: pgfId-1948974]The system only reports information present (and detectable) in network traffic. For example, there could be no user associated with an initiator host, or no referenced host detected in a connection where the protocol is not DNS, HTTP, or HTTPS.
 
     [bookmark: pgfId-1697259]Detection Method: FireSIGHT System vs NetFlow
 
     [bookmark: pgfId-1697260]With the exception of TCP flags and NetFlow autonomous system, prefix, and TOS data, the information available in NetFlow records is more limited than the information generated by monitoring network traffic using managed devices. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     [bookmark: pgfId-1697264]Logging Method: Beginning or End of Connection
 
     [bookmark: pgfId-1949339]When the system detects a connection, whether you can log it at its beginning or its end (or both).depends on how you configure the system to detect and handle it; see Logging the Beginning or End of Connections.
 
     [bookmark: pgfId-1949494]Beginning-of-connection events do not have information that must be determined by examining traffic over the duration of the session (for example, the total amount of data transmitted or the timestamp of the last packet in the connection). Beginning-of-connection events are also not guaranteed to have information about application or URL traffic in the session, and do not contain any details about the session’s encryption.
 
     [bookmark: pgfId-1916286]Inspection Method: Associated SSL, File, and Intrusion Policies
 
     [bookmark: pgfId-1916287]Only encrypted connections handled by an SSL policy have SSL-related information in the connection log. Only connections logged by access control rules with associated file policies contain file information. Similarly, you must associate intrusion policies with either access control rules or the default action to view intrusion information in the connection log.
 
     [bookmark: pgfId-1697270]Connection Event Type: Individual vs Summary
 
     [bookmark: pgfId-1697271]Connection summaries do not contain all of the information associated with their aggregated connections. For example, because client information is not used to aggregate connections into connection summaries, summaries do not contain client information.
 
     [bookmark: pgfId-1697272]Keep in mind that connection graphs are based on connection summary data, which use only end-of-connection logs. If you logged only beginning-of-connection data, connection graphs and connection summary event views contain no data.
 
     [bookmark: pgfId-1697275]Other Configurations
 
     [bookmark: pgfId-1722623]An advanced setting in the access control policy controls the number of characters the system stores in the connection log for each URL requested by monitored hosts in HTTP sessions. If you use this setting to disable URL logging, the system does not display individual URLs in the connection log, although you can still view category and reputation data, if it exists.
 
     [bookmark: pgfId-1697278]Also, not all connection events have a Reason, which is a field populated only in specific situations, such as when a user bypasses an Interactive Block configuration; see Reason.
 
     [bookmark: pgfId-1914819]The following table lists each connection event/Security Intelligence event field and whether the system displays information in that field, depending on the detection method, logging method, and connection event type. Note that, because Security Intelligence events are never aggregated, the Summary column refers only to connection event summaries.
 
      
       
     
 
     
 
     [bookmark: pgfId-1914844]Tip In the table views of both connection events and Security Intelligence events, several fields are hidden by default, including the Category and Tag fields for each type of application, NetFlow-related fields, SSL-related fields, and others. To show a hidden field in an event view, expand the search constraints, then click the field name under Disabled Columns.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1697854]
 
      
       
        
        [bookmark: pgfId-1927978]Table 39-1 [bookmark: 56706]Connection and Security Intelligence Data Based on Logging and Detection Methods 
 
        
        
         
         	 
           
           [bookmark: pgfId-1927992]Field 
          
  
         	 
           
           [bookmark: pgfId-1927994]Detection Method: 
          
  
         	 
           
           [bookmark: pgfId-1927998]Logging Method: 
          
  
         	 
           
           [bookmark: pgfId-1928002]Connection Event: 
          
  
        
 
         
         	 
           
           [bookmark: pgfId-1928011]FireSIGHT 
          
  
         	 
           
           [bookmark: pgfId-1928013]NetFlow 
          
  
         	 
           
           [bookmark: pgfId-1928015]Beginning 
          
  
         	 
           
           [bookmark: pgfId-1928017]End 
          
  
         	 
           
           [bookmark: pgfId-1928019]Single 
          
  
         	 
           
           [bookmark: pgfId-1928021]Summary 
          
  
        
 
         
         	[bookmark: pgfId-1928023]Time
  
         	[bookmark: pgfId-1928025]yes
  
         	[bookmark: pgfId-1928027]yes
  
         	[bookmark: pgfId-1928029]no
  
         	[bookmark: pgfId-1928031]yes
  
         	[bookmark: pgfId-1928033]no
  
         	[bookmark: pgfId-1928035]yes
  
        
 
         
         	[bookmark: pgfId-1928037]First Packet
  
         	[bookmark: pgfId-1928039]yes
  
         	[bookmark: pgfId-1928041]yes
  
         	[bookmark: pgfId-1928043]yes
  
         	[bookmark: pgfId-1928045]yes
  
         	[bookmark: pgfId-1928047]yes
  
         	[bookmark: pgfId-1928049]no
  
        
 
         
         	[bookmark: pgfId-1928051]Last Packet
  
         	[bookmark: pgfId-1928053]yes
  
         	[bookmark: pgfId-1928055]yes
  
         	[bookmark: pgfId-1928057]no
  
         	[bookmark: pgfId-1928059]yes
  
         	[bookmark: pgfId-1928061]yes
  
         	[bookmark: pgfId-1928063]no
  
        
 
         
         	[bookmark: pgfId-1928065]Action
  
         	[bookmark: pgfId-1928067]yes
  
         	[bookmark: pgfId-1928069]no
  
         	[bookmark: pgfId-1928071]yes
  
         	[bookmark: pgfId-1928073]yes
  
         	[bookmark: pgfId-1928075]yes
  
         	[bookmark: pgfId-1928077]no
  
        
 
         
         	[bookmark: pgfId-1928079]Reason
  
         	[bookmark: pgfId-1928081]yes
  
         	[bookmark: pgfId-1928083]no
  
         	[bookmark: pgfId-1928085]yes
  
         	[bookmark: pgfId-1928087]yes
  
         	[bookmark: pgfId-1928089]yes
  
         	[bookmark: pgfId-1928091]no
  
        
 
         
         	[bookmark: pgfId-1928093]Initiator IP
  
         	[bookmark: pgfId-1928095]yes
  
         	[bookmark: pgfId-1928097]yes
  
         	[bookmark: pgfId-1928099]yes
  
         	[bookmark: pgfId-1928101]yes
  
         	[bookmark: pgfId-1928103]yes
  
         	[bookmark: pgfId-1928105]yes
  
        
 
         
         	[bookmark: pgfId-1928107]Initiator Country
  
         	[bookmark: pgfId-1928109]yes
  
         	[bookmark: pgfId-1928111]no
  
         	[bookmark: pgfId-1928113]yes
  
         	[bookmark: pgfId-1928115]yes
  
         	[bookmark: pgfId-1928117]yes
  
         	[bookmark: pgfId-1928119]yes
  
        
 
         
         	[bookmark: pgfId-1928121]Initiator User
  
         	[bookmark: pgfId-1928123]yes
  
         	[bookmark: pgfId-1928125]yes
  
         	[bookmark: pgfId-1928127]yes
  
         	[bookmark: pgfId-1928129]yes
  
         	[bookmark: pgfId-1928131]yes
  
         	[bookmark: pgfId-1928133]yes
  
        
 
         
         	[bookmark: pgfId-1928135]Responder IP
  
         	[bookmark: pgfId-1928137]yes
  
         	[bookmark: pgfId-1928139]yes
  
         	[bookmark: pgfId-1928141]yes
  
         	[bookmark: pgfId-1928143]yes
  
         	[bookmark: pgfId-1928145]yes
  
         	[bookmark: pgfId-1928147]yes
  
        
 
         
         	[bookmark: pgfId-1928149]Responder Country
  
         	[bookmark: pgfId-1928151]yes
  
         	[bookmark: pgfId-1928153]no
  
         	[bookmark: pgfId-1928155]yes
  
         	[bookmark: pgfId-1928157]yes
  
         	[bookmark: pgfId-1928159]yes
  
         	[bookmark: pgfId-1928161]yes
  
        
 
         
         	[bookmark: pgfId-1928163]Security Intelligence Category
  
         	[bookmark: pgfId-1928165]yes
  
         	[bookmark: pgfId-1928167]no
  
         	[bookmark: pgfId-1928169]yes
  
         	[bookmark: pgfId-1928171]yes
  
         	[bookmark: pgfId-1928173]yes
  
         	[bookmark: pgfId-1928175]no
  
        
 
         
         	[bookmark: pgfId-1928177]Ingress Security Zone
  
         	[bookmark: pgfId-1928179]yes
  
         	[bookmark: pgfId-1928181]no
  
         	[bookmark: pgfId-1928183]yes
  
         	[bookmark: pgfId-1928185]yes
  
         	[bookmark: pgfId-1928187]yes
  
         	[bookmark: pgfId-1928189]yes
  
        
 
         
         	[bookmark: pgfId-1928191]Egress Security Zone
  
         	[bookmark: pgfId-1928193]yes
  
         	[bookmark: pgfId-1928195]no
  
         	[bookmark: pgfId-1928197]yes
  
         	[bookmark: pgfId-1928199]yes
  
         	[bookmark: pgfId-1928201]yes
  
         	[bookmark: pgfId-1928203]yes
  
        
 
         
         	[bookmark: pgfId-1928205]Source Port/ICMP Code
  
         	[bookmark: pgfId-1928207]yes
  
         	[bookmark: pgfId-1928209]yes
  
         	[bookmark: pgfId-1928211]yes
  
         	[bookmark: pgfId-1928213]yes
  
         	[bookmark: pgfId-1928215]yes
  
         	[bookmark: pgfId-1928217]no
  
        
 
         
         	[bookmark: pgfId-1928219]Destination Port/ICMP Type
  
         	[bookmark: pgfId-1928221]yes
  
         	[bookmark: pgfId-1928223]yes
  
         	[bookmark: pgfId-1928225]yes
  
         	[bookmark: pgfId-1928227]yes
  
         	[bookmark: pgfId-1928229]yes
  
         	[bookmark: pgfId-1928231]yes
  
        
 
         
         	[bookmark: pgfId-1928233]SSL Status
  
         	[bookmark: pgfId-1928235]yes
  
         	[bookmark: pgfId-1928237]no
  
         	[bookmark: pgfId-1928239]no
  
         	[bookmark: pgfId-1928241]yes
  
         	[bookmark: pgfId-1928243]yes
  
         	[bookmark: pgfId-1928245]no
  
        
 
         
         	[bookmark: pgfId-1928247]SSL Certificate Status
  
         	[bookmark: pgfId-1928249]yes
  
         	[bookmark: pgfId-1928251]no
  
         	[bookmark: pgfId-1928253]no
  
         	[bookmark: pgfId-1928255]yes
  
         	[bookmark: pgfId-1928257]yes
  
         	[bookmark: pgfId-1928259]no
  
        
 
         
         	[bookmark: pgfId-1928261]SSL Version 
  
         	[bookmark: pgfId-1928263]yes
  
         	[bookmark: pgfId-1928265]no
  
         	[bookmark: pgfId-1928267]no
  
         	[bookmark: pgfId-1928269]yes
  
         	[bookmark: pgfId-1928271]yes
  
         	[bookmark: pgfId-1928273]no
  
        
 
         
         	[bookmark: pgfId-1928275]SSL Policy
  
         	[bookmark: pgfId-1928277]yes
  
         	[bookmark: pgfId-1928279]no
  
         	[bookmark: pgfId-1928281]no
  
         	[bookmark: pgfId-1928283]yes
  
         	[bookmark: pgfId-1928285]yes
  
         	[bookmark: pgfId-1928287]no
  
        
 
         
         	[bookmark: pgfId-1928289]SSL Rule
  
         	[bookmark: pgfId-1928291]yes
  
         	[bookmark: pgfId-1928293]no
  
         	[bookmark: pgfId-1928295]no
  
         	[bookmark: pgfId-1928297]yes
  
         	[bookmark: pgfId-1928299]yes
  
         	[bookmark: pgfId-1928301]no
  
        
 
         
         	[bookmark: pgfId-1928303]SSL Cipher Suite
  
         	[bookmark: pgfId-1928305]yes
  
         	[bookmark: pgfId-1928307]no
  
         	[bookmark: pgfId-1928309]no
  
         	[bookmark: pgfId-1928311]yes
  
         	[bookmark: pgfId-1928313]yes
  
         	[bookmark: pgfId-1928315]no
  
        
 
         
         	[bookmark: pgfId-1928317]SSL Flow Flags
  
         	[bookmark: pgfId-1928319]yes
  
         	[bookmark: pgfId-1928321]no
  
         	[bookmark: pgfId-1928323]no
  
         	[bookmark: pgfId-1928325]yes
  
         	[bookmark: pgfId-1928327]yes
  
         	[bookmark: pgfId-1928329]no
  
        
 
         
         	[bookmark: pgfId-1928331]SSL Flow Messages
  
         	[bookmark: pgfId-1928333]yes
  
         	[bookmark: pgfId-1928335]no
  
         	[bookmark: pgfId-1928337]no
  
         	[bookmark: pgfId-1928339]yes
  
         	[bookmark: pgfId-1928341]yes
  
         	[bookmark: pgfId-1928343]no
  
        
 
         
         	[bookmark: pgfId-1928345]Application Protocol
  
         	[bookmark: pgfId-1928347]yes
  
         	[bookmark: pgfId-1928349]yes
  
         	[bookmark: pgfId-1928351]if available
  
         	[bookmark: pgfId-1928353]yes
  
         	[bookmark: pgfId-1928355]yes
  
         	[bookmark: pgfId-1928357]yes
  
        
 
         
         	[bookmark: pgfId-1928359]Client
  
         	[bookmark: pgfId-1928361]yes
  
         	[bookmark: pgfId-1928363]no
  
         	[bookmark: pgfId-1928365]if available
  
         	[bookmark: pgfId-1928367]yes
  
         	[bookmark: pgfId-1928369]yes
  
         	[bookmark: pgfId-1928371]no
  
        
 
         
         	[bookmark: pgfId-1928373]Client Version
  
         	[bookmark: pgfId-1928375]yes
  
         	[bookmark: pgfId-1928377]no
  
         	[bookmark: pgfId-1928379]if available
  
         	[bookmark: pgfId-1928381]yes
  
         	[bookmark: pgfId-1928383]yes
  
         	[bookmark: pgfId-1928385]no
  
        
 
         
         	[bookmark: pgfId-1928387]Web Application
  
         	[bookmark: pgfId-1928389]yes
  
         	[bookmark: pgfId-1928391]no
  
         	[bookmark: pgfId-1928393]if available
  
         	[bookmark: pgfId-1928395]yes
  
         	[bookmark: pgfId-1928397]yes
  
         	[bookmark: pgfId-1928399]no
  
        
 
         
         	[bookmark: pgfId-1928401]Category, Tag (Application Protocol, Client, Web Application)
  
         	[bookmark: pgfId-1928403]yes
  
         	[bookmark: pgfId-1928405]no
  
         	[bookmark: pgfId-1928407]if available
  
         	[bookmark: pgfId-1928409]yes
  
         	[bookmark: pgfId-1928411]yes
  
         	[bookmark: pgfId-1928413]no
  
        
 
         
         	[bookmark: pgfId-1928415]Application Risk
  
         	[bookmark: pgfId-1928417]yes
  
         	[bookmark: pgfId-1928419]no
  
         	[bookmark: pgfId-1928421]if available
  
         	[bookmark: pgfId-1928423]yes
  
         	[bookmark: pgfId-1928425]yes
  
         	[bookmark: pgfId-1928427]no
  
        
 
         
         	[bookmark: pgfId-1928429]Business Relevance
  
         	[bookmark: pgfId-1928431]yes
  
         	[bookmark: pgfId-1928433]no
  
         	[bookmark: pgfId-1928435]if available
  
         	[bookmark: pgfId-1928437]yes
  
         	[bookmark: pgfId-1928439]yes
  
         	[bookmark: pgfId-1928441]no
  
        
 
         
         	[bookmark: pgfId-1928443]URL
  
         	[bookmark: pgfId-1928445]yes
  
         	[bookmark: pgfId-1928447]no
  
         	[bookmark: pgfId-1928449]if available
  
         	[bookmark: pgfId-1928451]yes
  
         	[bookmark: pgfId-1928453]yes
  
         	[bookmark: pgfId-1928455]no
  
        
 
         
         	[bookmark: pgfId-1928457]URL Category
  
         	[bookmark: pgfId-1928459]yes
  
         	[bookmark: pgfId-1928461]no
  
         	[bookmark: pgfId-1928463]if available
  
         	[bookmark: pgfId-1928465]yes
  
         	[bookmark: pgfId-1928467]yes
  
         	[bookmark: pgfId-1928469]no
  
        
 
         
         	[bookmark: pgfId-1928471]URL Reputation
  
         	[bookmark: pgfId-1928473]yes
  
         	[bookmark: pgfId-1928475]no
  
         	[bookmark: pgfId-1928477]if available
  
         	[bookmark: pgfId-1928479]yes
  
         	[bookmark: pgfId-1928481]yes
  
         	[bookmark: pgfId-1928483]no
  
        
 
         
         	[bookmark: pgfId-1928485]VLAN ID
  
         	[bookmark: pgfId-1928487]yes
  
         	[bookmark: pgfId-1928489]no
  
         	[bookmark: pgfId-1928491]yes
  
         	[bookmark: pgfId-1928493]yes
  
         	[bookmark: pgfId-1928495]yes
  
         	[bookmark: pgfId-1928497]no
  
        
 
         
         	[bookmark: pgfId-1928499]Referenced Host
  
         	[bookmark: pgfId-1928501]yes
  
         	[bookmark: pgfId-1928503]no
  
         	[bookmark: pgfId-1928505]no
  
         	[bookmark: pgfId-1928507]yes
  
         	[bookmark: pgfId-1928509]yes
  
         	[bookmark: pgfId-1928511]no
  
        
 
         
         	[bookmark: pgfId-1928513]User Agent
  
         	[bookmark: pgfId-1928515]yes
  
         	[bookmark: pgfId-1928517]no
  
         	[bookmark: pgfId-1928519]no
  
         	[bookmark: pgfId-1928521]yes
  
         	[bookmark: pgfId-1928523]yes
  
         	[bookmark: pgfId-1928525]no
  
        
 
         
         	[bookmark: pgfId-1928527]HTTP Referrer
  
         	[bookmark: pgfId-1928529]yes
  
         	[bookmark: pgfId-1928531]no
  
         	[bookmark: pgfId-1928533]no
  
         	[bookmark: pgfId-1928535]yes
  
         	[bookmark: pgfId-1928537]yes
  
         	[bookmark: pgfId-1928539]no
  
        
 
         
         	[bookmark: pgfId-1928541]IOC
  
         	[bookmark: pgfId-1928543]yes
  
         	[bookmark: pgfId-1928545]no
  
         	[bookmark: pgfId-1928547]yes
  
         	[bookmark: pgfId-1928549]yes
  
         	[bookmark: pgfId-1928551]yes
  
         	[bookmark: pgfId-1928553]no
  
        
 
         
         	[bookmark: pgfId-1928555]Intrusion Events
  
         	[bookmark: pgfId-1928557]yes
  
         	[bookmark: pgfId-1928559]no
  
         	[bookmark: pgfId-1928561]no
  
         	[bookmark: pgfId-1928563]yes
  
         	[bookmark: pgfId-1928565]yes
  
         	[bookmark: pgfId-1928567]no
  
        
 
         
         	[bookmark: pgfId-1928569]Files
  
         	[bookmark: pgfId-1928571]yes
  
         	[bookmark: pgfId-1928573]no
  
         	[bookmark: pgfId-1928575]no
  
         	[bookmark: pgfId-1928577]yes
  
         	[bookmark: pgfId-1928579]yes
  
         	[bookmark: pgfId-1928581]no
  
        
 
         
         	[bookmark: pgfId-1986162]Intrusion Policy
  
         	[bookmark: pgfId-1986164]yes
  
         	[bookmark: pgfId-1986166]no
  
         	[bookmark: pgfId-1986168]yes
  
         	[bookmark: pgfId-1986170]yes
  
         	[bookmark: pgfId-1986172]yes
  
         	[bookmark: pgfId-1986174]no
  
        
 
         
         	[bookmark: pgfId-1928583]Access Control Policy
  
         	[bookmark: pgfId-1928585]yes
  
         	[bookmark: pgfId-1928587]no
  
         	[bookmark: pgfId-1928589]yes
  
         	[bookmark: pgfId-1928591]yes
  
         	[bookmark: pgfId-1928593]yes
  
         	[bookmark: pgfId-1928595]no
  
        
 
         
         	[bookmark: pgfId-1928597]Access Control Rule
  
         	[bookmark: pgfId-1928599]yes
  
         	[bookmark: pgfId-1928601]no
  
         	[bookmark: pgfId-1928603]yes
  
         	[bookmark: pgfId-1928605]yes
  
         	[bookmark: pgfId-1928607]yes
  
         	[bookmark: pgfId-1928609]no
  
        
 
         
         	[bookmark: pgfId-1986223]Network Analysis Policy
  
         	[bookmark: pgfId-1986225]yes
  
         	[bookmark: pgfId-1986227]no
  
         	[bookmark: pgfId-1986229]yes
  
         	[bookmark: pgfId-1986231]yes
  
         	[bookmark: pgfId-1986233]yes
  
         	[bookmark: pgfId-1986235]no
  
        
 
         
         	[bookmark: pgfId-1928611]Device
  
         	[bookmark: pgfId-1928613]yes
  
         	[bookmark: pgfId-1928615]yes
  
         	[bookmark: pgfId-1928617]yes
  
         	[bookmark: pgfId-1928619]yes
  
         	[bookmark: pgfId-1928621]yes
  
         	[bookmark: pgfId-1928623]yes
  
        
 
         
         	[bookmark: pgfId-1928625]Ingress Interface
  
         	[bookmark: pgfId-1928627]yes
  
         	[bookmark: pgfId-1928629]no
  
         	[bookmark: pgfId-1928631]yes
  
         	[bookmark: pgfId-1928633]yes
  
         	[bookmark: pgfId-1928635]yes
  
         	[bookmark: pgfId-1928637]yes
  
        
 
         
         	[bookmark: pgfId-1928639]Egress Interface
  
         	[bookmark: pgfId-1928641]yes
  
         	[bookmark: pgfId-1928643]no
  
         	[bookmark: pgfId-1928645]yes
  
         	[bookmark: pgfId-1928647]yes
  
         	[bookmark: pgfId-1928649]yes
  
         	[bookmark: pgfId-1928651]yes
  
        
 
         
         	[bookmark: pgfId-1928653]Security Context (ASA only)
  
         	[bookmark: pgfId-1928655]yes
  
         	[bookmark: pgfId-1928657]no
  
         	[bookmark: pgfId-1928659]yes
  
         	[bookmark: pgfId-1928661]yes
  
         	[bookmark: pgfId-1928663]yes
  
         	[bookmark: pgfId-1928665]yes
  
        
 
         
         	[bookmark: pgfId-1928667]TCP Flags
  
         	[bookmark: pgfId-1928669]no
  
         	[bookmark: pgfId-1928671]yes
  
         	[bookmark: pgfId-1928673]no
  
         	[bookmark: pgfId-1928675]yes
  
         	[bookmark: pgfId-1928677]yes
  
         	[bookmark: pgfId-1928679]no
  
        
 
         
         	[bookmark: pgfId-1928681]NetFlow Destination/Source Autonomous System
  
         	[bookmark: pgfId-1928683]no
  
         	[bookmark: pgfId-1928685]yes
  
         	[bookmark: pgfId-1928687]no
  
         	[bookmark: pgfId-1928689]yes
  
         	[bookmark: pgfId-1928691]yes
  
         	[bookmark: pgfId-1928693]no
  
        
 
         
         	[bookmark: pgfId-1928695]NetFlow Destination/Source Prefix
  
         	[bookmark: pgfId-1928697]no
  
         	[bookmark: pgfId-1928699]yes
  
         	[bookmark: pgfId-1928701]no
  
         	[bookmark: pgfId-1928703]yes
  
         	[bookmark: pgfId-1928705]yes
  
         	[bookmark: pgfId-1928707]no
  
        
 
         
         	[bookmark: pgfId-1928709]NetFlow Destination/Source TOS
  
         	[bookmark: pgfId-1928711]no
  
         	[bookmark: pgfId-1928713]yes
  
         	[bookmark: pgfId-1928715]no
  
         	[bookmark: pgfId-1928717]yes
  
         	[bookmark: pgfId-1928719]yes
  
         	[bookmark: pgfId-1928721]no
  
        
 
         
         	[bookmark: pgfId-1928723]NetFlow SNMP Input/Output
  
         	[bookmark: pgfId-1928725]no
  
         	[bookmark: pgfId-1928727]yes
  
         	[bookmark: pgfId-1928729]no
  
         	[bookmark: pgfId-1928731]yes
  
         	[bookmark: pgfId-1928733]yes
  
         	[bookmark: pgfId-1928735]no
  
        
 
         
         	[bookmark: pgfId-1928737]Source Device
  
         	[bookmark: pgfId-1928739]yes
  
         	[bookmark: pgfId-1928741]yes
  
         	[bookmark: pgfId-1928746]FireSIGHT
  
         	[bookmark: pgfId-1928748]yes
  
         	[bookmark: pgfId-1928750]yes
  
         	[bookmark: pgfId-1928752]yes
  
        
 
         
         	[bookmark: pgfId-1928754]NetBIOS Domain
  
         	[bookmark: pgfId-1928756]yes
  
         	[bookmark: pgfId-1928758]no
  
         	[bookmark: pgfId-1928760]yes
  
         	[bookmark: pgfId-1928762]yes
  
         	[bookmark: pgfId-1928764]yes
  
         	[bookmark: pgfId-1928766]no
  
        
 
         
         	[bookmark: pgfId-1928768]Initiator Packets
  
         	[bookmark: pgfId-1928770]yes
  
         	[bookmark: pgfId-1928772]yes
  
         	[bookmark: pgfId-1928774]not useful
  
         	[bookmark: pgfId-1928776]yes
  
         	[bookmark: pgfId-1928778]yes
  
         	[bookmark: pgfId-1928780]yes
  
        
 
         
         	[bookmark: pgfId-1928782]Responder Packets
  
         	[bookmark: pgfId-1928784]yes
  
         	[bookmark: pgfId-1928786]yes
  
         	[bookmark: pgfId-1928788]not useful
  
         	[bookmark: pgfId-1928790]yes
  
         	[bookmark: pgfId-1928792]yes
  
         	[bookmark: pgfId-1928794]yes
  
        
 
         
         	[bookmark: pgfId-1928796]Initiator Bytes
  
         	[bookmark: pgfId-1928798]yes
  
         	[bookmark: pgfId-1928800]yes
  
         	[bookmark: pgfId-1928802]not useful
  
         	[bookmark: pgfId-1928804]yes
  
         	[bookmark: pgfId-1928806]yes
  
         	[bookmark: pgfId-1928808]yes
  
        
 
         
         	[bookmark: pgfId-1928810]Responder Bytes
  
         	[bookmark: pgfId-1928812]yes
  
         	[bookmark: pgfId-1928814]yes
  
         	[bookmark: pgfId-1928816]not useful
  
         	[bookmark: pgfId-1928818]yes
  
         	[bookmark: pgfId-1928820]yes
  
         	[bookmark: pgfId-1928822]yes
  
        
 
         
         	[bookmark: pgfId-1928824]Connections
  
         	[bookmark: pgfId-1928826]yes
  
         	[bookmark: pgfId-1928828]yes
  
         	[bookmark: pgfId-1928830]no
  
         	[bookmark: pgfId-1928832]yes
  
         	[bookmark: pgfId-1928834]no
  
         	[bookmark: pgfId-1928836]yes
  
        
 
         
         	[bookmark: pgfId-1928838]Count
  
         	[bookmark: pgfId-1928840]yes
  
         	[bookmark: pgfId-1928842]yes
  
         	[bookmark: pgfId-1928844]yes
  
         	[bookmark: pgfId-1928846]yes
  
         	[bookmark: pgfId-1928848]yes
  
         	[bookmark: pgfId-1928850]no
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1696596][bookmark: 89494]Viewing [bookmark: marker-1696592]Connection and Security Intelligence Data 
 
    [bookmark: pgfId-1696597]License: feature dependent
 
    [bookmark: pgfId-1828269]Supported Devices: feature dependent
 
    [bookmark: pgfId-1828273]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1849770]To help you gain in-depth insight into connection data, the system can present connection data both graphically and in a tabular format. The page you see when you access connection data differs depending on the workflow you use. You can use one of the predefined workflows or create a custom workflow that displays only the information that matches your specific needs.
 
    [bookmark: pgfId-1822937]Security Intelligence events require a Protection license and appear in table form only. Security Intelligence data is not supported on Series 2 managed devices or on DC500 Defense Centers. You cannot create data graphs from Security Intelligence events, although their connection event counterparts are viewable in graph form. For interactive graphic views of Security Intelligence data, you can view the Security Intelligence section of the Context Explorer. See Understanding the Security Intelligence Section for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-1971950]Note The information available for any individual connection or Security Intelligence event depends on several factors, including licenses and appliance model. For more information, see License and Model Requirements for Connection Logging.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1698253]Each table view or graph contains information about the connections or connection summaries you are viewing, including timestamps, IP addresses, applications, and so on. The information available for any individual connection detected by the FireSIGHT System depends on several factors, including detection method and logging options. For more information, see Understanding Connection and Security Intelligence Data Fields and Information Available in Connection and Security Intelligence Events.
 
     
      
    
 
    
 
    [bookmark: pgfId-1579047]Tip The Connection Summary dashboard can provide you with an at-a-glance view of the connections logged by the system, and the Summary Dashboard displays Security Intelligence event data. For more information, see Using Dashboards.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1696055]To view connection or Security Intelligence data:
 
    [bookmark: pgfId-1696056]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-1696057]Step 1 You have two options:
 
     
      
      	 [bookmark: pgfId-1825173]To view connection events, select  Analysis > Connections > Events .
 
      	 [bookmark: pgfId-1825253]To view Security Intelligence events, select  Analysis > Connections > Security Intelligence Events .
 
     
 
    
 
    [bookmark: pgfId-1696058]The first page of the default connection or Security Intelligence workflow appears. For connection events, there are two possibilities:
 
     
      
      	 [bookmark: pgfId-1696061]The workflow page displays a  graph . See Working with Connection Graphs for information on the actions you can perform.
 
      	 [bookmark: pgfId-1696065]The workflow page displays a  table . See Working with Connection and Security Intelligence Data Tables for information on the actions you can perform.
 
     
 
    
 
    [bookmark: pgfId-1824932]For Security Intelligence events, the workflow page displays a table.
 
    [bookmark: pgfId-1696067]To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
    [bookmark: pgfId-1887517]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1523366][bookmark: 20919]Working with Con[bookmark: marker-1673139]nection Graphs
 
    [bookmark: pgfId-1610041]License: Any
 
    [bookmark: pgfId-1646768]One of the ways the system can present connection data is graphically. There are three different types of connection graphs: line graphs, bar graphs, and pie charts. Bar graphs and line graphs can display multiple datasets; that is, they can display several values on the y-axis for each x-axis data point.
 
    [bookmark: pgfId-1524478]You can manipulate connection graphs in various ways, including:
 
     
     	 [bookmark: pgfId-1524479]changing the type of data that the graph displays
 
     	 [bookmark: pgfId-1524480]switching between graph types
 
     	 [bookmark: pgfId-1524481]constraining the graph so it shows data for specific time ranges, hosts, applications, ports, and devices
 
    
 
    [bookmark: pgfId-1524484]Because traffic profiles are based on connection data (see Creating Traffic Profiles), you can view traffic profiles as line graphs. You can manipulate these graphs in the same way as you would any other connection graph, with some restrictions. 
 
    [bookmark: pgfId-1823444]You cannot create data graphs from Security Intelligence events, although their connection event counterparts are viewable in graph form. For interactive graphic views of Security Intelligence data, you can view the Security Intelligence section of the Context Explorer. See Understanding the Security Intelligence Section for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-1563306]Note To view traffic profiles, you must have Administrator access. Compare this with other connection graphs, which you can view with any Security Analyst or Administrator access.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1579492]When you view a connection graph, as described in Viewing Connection and Security Intelligence Data, you can perform the basic actions described in the following table.
 
    [bookmark: pgfId-1616466]Access: Admin/Any Security Analyst
 
    [bookmark: pgfId-1579541]
 
     
      
       
       [bookmark: pgfId-1579502]Table 39-2 [bookmark: 51585]Basic Connection Graph Functions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1579506]To... 
         
  
        	 
          
          [bookmark: pgfId-1579508]You can... 
         
  
       
 
        
        	[bookmark: pgfId-1579510]learn more about the data that appears
  
        	[bookmark: pgfId-1579514]find more information in Understanding Connection and Security Intelligence Data Fields.
  
       
 
        
        	[bookmark: pgfId-1579517]modify the time and date range
  
        	[bookmark: pgfId-1579521]find more information in Setting Event Time Constraints.
  
       
 
        
        	[bookmark: pgfId-1579524]view a host’s profile
  
        	[bookmark: pgfId-1579526]on a graph displaying connection data by initiator or responder, click either a bar on a bar graph or a wedge on a pie chart and select View Host Profile.
  
       
 
        
        	[bookmark: pgfId-1585111]use a different workflow, including a custom workflow
  
        	[bookmark: pgfId-1585113]click (switch workflow) by the workflow title.
  
       
 
        
        	[bookmark: pgfId-1579528]navigate between pages in the current workflow
  
        	[bookmark: pgfId-1579532]find more information in Using Workflow Pages.
  
       
 
        
        	[bookmark: pgfId-1579535]navigate to other event views to view associated events
  
        	[bookmark: pgfId-1579539]find more information in Navigating Between Workflows.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1524492]There are many other ways you can manipulate connection graphs as you perform in-depth analysis of connection data. For more information, see:
 
     
     	 [bookmark: pgfId-1562248]Changing the Graph Type explains how to change between bar graphs and pie chart, and between standard line graphs and velocity graphs.
 
     	 [bookmark: pgfId-1562289]Selecting Datasets explains how to display several values on the y-axis for each x-axis data point on line graphs and bar graphs.
 
     	 [bookmark: pgfId-1559528]Viewing Information About Aggregated Connection Data explains how to get more information about the data points on a graph, or to display the host profile of a host whose statistics are being graphed.
 
     	 [bookmark: pgfId-1558861]Manipulating a Connection Graph on a Workflow Page explains how to constrain the data that appears on a connection graph without advancing the workflow to the next page.
 
     	 [bookmark: pgfId-1558865]Drilling Down Through Connection Data Graphs explains how to constrain the data that appears on a connection graph while advancing the workflow to the next page.
 
     	 [bookmark: pgfId-1558869]Recentering and Zooming on Line Graphs explains how to recenter a line graph around any point in time.
 
     	 [bookmark: pgfId-1558877]Selecting Data to Graph explains how to change the data displayed on a connection graph by changing its x- or y-axis.
 
     	 [bookmark: pgfId-1558885]Detaching Connection Graphs explains how you can detach a connection graph into a new browser window and perform further analysis without affecting the default time range for the Defense Center. 
 
     	 [bookmark: pgfId-1558892]Exporting Connection Data explains how to export the connection data used to construct a graph as a CSV (comma-separated values) file.
 
    
 
     
      [bookmark: pgfId-1579728][bookmark: 98777]Changing the [bookmark: marker-1579713]Graph Type
 
     [bookmark: pgfId-1610058]License: Any
 
     [bookmark: pgfId-1579715]There are three different connection graphs: line graphs, bar graphs, and pie charts. Line graphs plot data over time. For example, the following line graph displays the total number of connections detected on a monitored network over a one-hour time span. Traffic profiles are always displayed as line graphs.
 
     [bookmark: pgfId-1999356]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1524525]By default, line graphs appear in standard view. A standard line graph aggregates data over five minute intervals, plots the aggregated data points, and connects the points.
 
     [bookmark: pgfId-1524526]However, you can change a line graph from standard view to velocity view. A velocity line graph shows the rate of change between those data points. If you change the above graph to a velocity graph, the y-axis changes from indicating the number of connections to indicating the change in the number of connections over time.
 
     [bookmark: pgfId-1999380]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1524560]Follow the directions in the following table to switch between standard and velocity line graphs, and to switch between bar graphs and pie charts.
 
     [bookmark: pgfId-1616479]Access: Admin/Any Security Analyst
 
      
       [bookmark: pgfId-1524599]
 
       
        
         
         [bookmark: pgfId-1524572]Table 39-3 Changing Graph Types 
 
         
         
          
          	 
            
            [bookmark: pgfId-1524576]To change... 
           
  
          	 
            
            [bookmark: pgfId-1524578]You can... 
           
  
         
 
          
          	[bookmark: pgfId-1524580]a bar graph to a pie chart
  
          	[bookmark: pgfId-1524582]click Switch to Pie.
 [bookmark: pgfId-1524583]Note that pie charts cannot display multiple datasets; see Selecting Datasets.
  
         
 
          
          	[bookmark: pgfId-1524588]a pie chart to a bar graph
  
          	[bookmark: pgfId-1524590]click Switch to Bar.
  
         
 
          
          	[bookmark: pgfId-1524592]a line graph from a standard graph to a velocity graph 
  
          	[bookmark: pgfId-1524594]click Velocity and select Velocity.
  
         
 
          
          	[bookmark: pgfId-1524596]a line graph from a velocity graph to a standard graph 
  
          	[bookmark: pgfId-1524598]click Velocity and select Standard.
  
         
 
         
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1562536][bookmark: 30918]Selecting D[bookmark: marker-1562535]atasets
 
     [bookmark: pgfId-1610079]License: Any
 
     [bookmark: pgfId-1562538]Both bar graphs and line graphs can display multiple datasets; that is, they can display several values on the y-axis for each x-axis data point. For example, you could display the total number of unique initiators and the total number of unique Pie charts can only display one dataset. 
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
      
       
        
        [bookmark: pgfId-1562597]Table 39-4 [bookmark: 55610]Dataset Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-1562601]If the y-axis displays... 
          
  
         	 
           
           [bookmark: pgfId-1562603]You can select as datasets... 
          
  
        
 
         
         	[bookmark: pgfId-1562605]Connections
  
         	[bookmark: pgfId-1562607]the default only, which is the number of connections detected on the monitored network (Connections)
 [bookmark: pgfId-1562608]This is the only option for traffic profile graphs.
  
        
 
         
         	[bookmark: pgfId-1562610]KBytes
  
         	[bookmark: pgfId-1562612]combinations of:
 
           
           	 [bookmark: pgfId-1562613]the total kilobytes transmitted on the monitored network ( Total KBytes )
 
           	 [bookmark: pgfId-1562614]the number of kilobytes transmitted from host IP addresses on the monitored network ( Initiator KBytes )
 
           	 [bookmark: pgfId-1562615]the number of kilobytes received by host IP addresses on the monitored network ( Responder KBytes )
 
          
  
        
 
         
         	[bookmark: pgfId-1562617]KBytes Per Second
  
         	[bookmark: pgfId-1562619]the default only, which is the total kilobytes per second transmitted on the monitored network (Total KBytes Per Second)
  
        
 
         
         	[bookmark: pgfId-1562621]Packets
  
         	[bookmark: pgfId-1562623]combinations of:
 
           
           	 [bookmark: pgfId-1562624]the total packets transmitted on the monitored network ( Total Packets )
 
           	 [bookmark: pgfId-1562625]the number of packets transmitted from host IP addresses on the monitored network ( Initiator Packets )
 
           	 [bookmark: pgfId-1562626]the number of packets received by host IP addresses on the monitored network ( Responder Packets )
 
          
  
        
 
         
         	[bookmark: pgfId-1562628]Unique Hosts
  
         	[bookmark: pgfId-1781100]combinations of:
 
           
           	 [bookmark: pgfId-1781101]the number of unique session initiators on the monitored network ( Unique Initiators )
 
           	 [bookmark: pgfId-1562632]the number of unique session responders on the monitored network ( Unique Responders )
 
          
  
        
 
         
         	[bookmark: pgfId-1562634]Unique Application Protocols
  
         	[bookmark: pgfId-1562636]the default only, which is the number of unique application protocols on the monitored network (Unique Application Protocols)
  
        
 
         
         	[bookmark: pgfId-1562638]Unique Users
  
         	[bookmark: pgfId-1562640]the default only, which is the number of unique users logged into session initiators on the monitored network (Unique Initiator Users)
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1562644]To select the datasets displayed on a connection graph:
 
     [bookmark: pgfId-1562645]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1562646]Step 1 Click Datasets and select the datasets you want to graph.
 
     [bookmark: pgfId-1562650]The datasets you can select are described in the Dataset Options table.
 
     [bookmark: pgfId-1887158]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1562498][bookmark: 15374]Viewing Information About Aggregated [bookmark: marker-1557607]Connection Data
 
     [bookmark: pgfId-1610092]License: Any
 
     [bookmark: pgfId-1557610]Connection graphs are based on aggregated data over five-minute intervals, also called connection summaries. You can get more information about the specific connection summaries used to construct a connection graph. For example, on a graph of connections over time, you may want to know exactly how many connections were detected over a specific interval.
 
     [bookmark: pgfId-1557612]To get detailed information on aggregated connection data:
 
     [bookmark: pgfId-1616186]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1557614]Step 1 Position your cursor over a point on a line graph a bar in a bar graph, or a wedge in a pie chart. A tooltip appears with detailed information about the data used to construct that portion of the graph.
 
     [bookmark: pgfId-1887189]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1557628][bookmark: 35542]Manipulating a [bookmark: marker-1557627]Connection Graph on a Workflow Page
 
     [bookmark: pgfId-1610109]License: Any
 
     [bookmark: pgfId-1557630]When you open a connection data workflow, the data is initially constrained only by a time range. You can constrain connection graphs with additional criteria without advancing the workflow to the next page. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1557631]Tip Constraining connection data in this manner changes the x-axis (also called the independent variable when viewing a pie chart) of the graph. To change the independent variable without constraining the connection data, use the X-Axis and Y-Axis menus. For more information, see Selecting Data to Graph.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1869313]To constrain connection data:
 
     [bookmark: pgfId-1869314]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1869315]Step 1 Click a point on a line graph, a bar on a bar graph, or a wedge on a pie chart.
 
     [bookmark: pgfId-1557639]Step 2 Select a View by... option.
 
     [bookmark: pgfId-1557642]You can constrain connection data based on any of the criteria listed in the X-Axis Functions table.
 
     [bookmark: pgfId-1557644]For example, consider a graph of connections over time. If you constrain a point on the graph by port, a bar graph appears, showing the 10 most active ports based on the number of detected connection events, but constrained by the ten-minute time span that is centered on the point you clicked.
 
     [bookmark: pgfId-1661016]If you further constrain the graph by clicking on one of the bars and selecting View by Initiator IP, a new bar graph appears, constrained by not only the same ten-minute time span as before, but also by the port represented by the bar you clicked.
 
      
       
     
 
     
 
     [bookmark: pgfId-1661025]Note Unless you are working with a detached graph, constraining connection data in this manner changes the time range. For more information on detached graphs, see Detaching Connection Graphs.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1887255]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1557677][bookmark: 13962]Drilling Down Through [bookmark: marker-1557676]Connection Data Graphs
 
     [bookmark: pgfId-1610126]License: Any
 
     [bookmark: pgfId-1557679]When you open a connection data workflow, the data is initially constrained only by a time range. You can constrain connection graphs while advancing the workflow to the next page.
 
     [bookmark: pgfId-1869300]To drill down in a connection data workflow:
 
     [bookmark: pgfId-1869301]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1869302]Step 1 Click a point on a line graph, a bar on a bar graph, or a wedge on a pie chart.
 
     [bookmark: pgfId-1557683]Step 2 Select Drill-down.
 
     [bookmark: pgfId-1557697]You drill down to the next workflow page, constraining using the item you clicked:
 
      
       
       	 [bookmark: pgfId-1660496]Clicking a point on a line graph constrains the time range on the next page to a 10-minute span, centered on the point you clicked.
 
       	 [bookmark: pgfId-1660639]Clicking a bar on a bar graph or a wedge on a pie chart constrains the next page based on the criterion represented by the bar or wedge. For example, clicking on a bar that represents port use drills down to the next page in the workflow, which is constrained by the port represented by the bar you clicked.
 
      
 
     
 
     [bookmark: pgfId-1887292]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1557724][bookmark: 85130]Recentering and Zooming on[bookmark: marker-1557723] Line Graphs
 
     [bookmark: pgfId-1610139]License: Any
 
     [bookmark: pgfId-1557726]You can recenter line graphs around any point in time. You can recenter using either the default time range, or you can choose a different time range.
 
      
       
     
 
     
 
     [bookmark: pgfId-1557727]Note Unless you are working with a detached graph, recentering changes the default time range. For more information on detached graphs, see Detaching Connection Graphs.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1557732]To recenter using the default time range:
 
     [bookmark: pgfId-1616319]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1557734]Step 1 Click the point on the line graph where you want to recenter the graph, and click recenter.
 
     [bookmark: pgfId-1557735]The graph is redrawn, centered on the point you clicked, with a time span that is the same length as your default time range.
 
     [bookmark: pgfId-1887531]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1557736]To recenter using a different time range:
 
     [bookmark: pgfId-1616344]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1557738]Step 1 Click the point where you want to recenter the graph and click Zoom.
 
      
       [bookmark: pgfId-1557742]
 
      [bookmark: pgfId-1557743]Step 2 Select the time span for the new graph, which can be as short as one hour or as long as one week.
 
      [bookmark: pgfId-1557744]The graph is redrawn, centered on the point you clicked, with the time span you selected.
 
      [bookmark: pgfId-1887336]
 
       
       
 
      
 
      
 
     
 
    
 
     
      [bookmark: pgfId-1557793][bookmark: 19505]Selecting Data to[bookmark: marker-1557792] Graph
 
     [bookmark: pgfId-1610156]License: Any
 
     [bookmark: pgfId-1557795]You can display different data on a connection graph by changing either the x-axis, the y-axis, or both.
 
     [bookmark: pgfId-1557796]Note that on a pie chart, changing the x-axis changes the independent variable and changing the y-axis changes the dependent variable. For example, consider a pie chart that graphs kilobytes per port. In this case, the x-axis is Responder Port and the y-axis is KBytes. This pie chart represents the total kilobytes of data transmitted over a monitored network during a certain interval. The wedges of the pie represent the percent of the data that was detected on each port. If you change the x-axis of the chart to Application Protocol, the pie chart still represents the total kilobytes of data transmitted, but the wedges of the pie represent the percentage of the data transmitted for each detected application protocol.
 
     [bookmark: pgfId-1557814]However, if you change the y-axis of the first pie chart to Packets, the pie chart represents the total number of packets transmitted over the monitored network during a certain interval, and the wedges of the pie represent the percentage of the total number of packets that was detected on each port.
 
      
       
        
        [bookmark: pgfId-1557833]Table 39-5 [bookmark: 82813]X-Axis Functions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1557837]To graph connection data... 
          
  
         	 
           
           [bookmark: pgfId-1557839]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1625832]by the 10 most active application protocols on the monitored network based on the number of detected connection events
  
         	[bookmark: pgfId-1625834]click X-Axis and select Application Protocol.
  
        
 
         
         	[bookmark: pgfId-1631261]by the 10 most active managed devices on the monitored network based on the number of detected connection events
  
         	[bookmark: pgfId-1631263]click X-Axis and select Device.
  
        
 
         
         	[bookmark: pgfId-1557852]by the 10 most active host IP addresses on the monitored network based on the number of connection events where that host IP address initiated the connection transaction
  
         	[bookmark: pgfId-1557854]click X-Axis and select Initiator IP.
  
        
 
         
         	[bookmark: pgfId-1557856]by the 10 most active users on the monitored network based on the number of connection events where the host where the user is logged in initiated the connection transaction
  
         	[bookmark: pgfId-1557858]click X-Axis and select Initiator User.
  
        
 
         
         	[bookmark: pgfId-1557860]by the 10 most active host IP addresses on the monitored network based on the number of connection events where that address was the responder in the connection transaction
  
         	[bookmark: pgfId-1557862]click X-Axis and select Responder IP.
  
        
 
         
         	[bookmark: pgfId-1557864]by the 10 most active ports on the monitored network based on the number of detected connection events where the host was the responder in the connection transaction
  
         	[bookmark: pgfId-1557866]click X-Axis and select Responder Port.
  
        
 
         
         	[bookmark: pgfId-1557876]by the 10 most active source devices, which include NetFlow-enabled devices that exported the connection data for the connections, plus a source device named FireSIGHT for all connections detected by Cisco managed devices
  
         	[bookmark: pgfId-1557881]click X-Axis and select Source Device.
  
        
 
         
         	[bookmark: pgfId-1557883]over time
  
         	[bookmark: pgfId-1557885]click X-Axis and select Time.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1557890]Follow the directions in the following table to change the y-axis of a connection graph.
 
     [bookmark: pgfId-1557932]
 
      
       
        
        [bookmark: pgfId-1557897]Table 39-6 [bookmark: 26559]Y-Axis Functions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1557901]To... 
          
  
         	 
           
           [bookmark: pgfId-1557903]You can... 
          
  
        
 
         
         	[bookmark: pgfId-1557905]graph the number of connections on the monitored network by the criterion you chose for the x-axis
  
         	[bookmark: pgfId-1557907]click Y-Axis and select Connections.
  
        
 
         
         	[bookmark: pgfId-1557909]graph the total kilobytes transmitted on the monitored network by the criterion you chose for the x-axis
  
         	[bookmark: pgfId-1557911]click Y-Axis and select KBytes.
  
        
 
         
         	[bookmark: pgfId-1557913]graph the total kilobytes per second transmitted on the monitored network by the criterion you chose for the x-axis
  
         	[bookmark: pgfId-1557915]click Y-Axis and select KBytes Per Second.
  
        
 
         
         	[bookmark: pgfId-1557917]graph the total number of packets transmitted on the monitored network by the criterion you chose for the x-axis
  
         	[bookmark: pgfId-1557919]click Y-Axis and select Packets.
  
        
 
         
         	[bookmark: pgfId-1557921]graph the total number of unique hosts detected on the monitored network by the criterion you chose for the x-axis
  
         	[bookmark: pgfId-1557923]click Y-Axis and select Unique Hosts.
  
        
 
         
         	[bookmark: pgfId-1557925]graph the total number of unique application protocols detected on the monitored network by the criterion you chose for the x-axis
  
         	[bookmark: pgfId-1557927]click Y-Axis and select Unique Application Protocols.
  
        
 
         
         	[bookmark: pgfId-1557929]graph the total number of unique users detected on the monitored network by the criterion you chose for the x-axis
  
         	[bookmark: pgfId-1557931]click Y-Axis and select Unique Users.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1558007][bookmark: 60118]Detaching [bookmark: marker-1558006]Connection Graphs
 
     [bookmark: pgfId-1609794]License: Any
 
     [bookmark: pgfId-1558009]If you want to perform further analysis on a connection graph, without affecting the default time range, you can detach the graph into a new browser window. You can perform all the same actions on detached connection graphs that you can on embedded connection graphs. You can also print a detached graph by clicking Print. Note that traffic profile graphs are, by default, detached graphs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1558010]Tip If you are viewing a detached graph, click New Window to create another copy of the detached graph in a new browser window. You can then perform different analyses on each of the detached graphs.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1558011]To detach a graph:
 
     [bookmark: pgfId-1616369]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1558013]Step 1 Click Detach.
 
     [bookmark: pgfId-1887542]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1558016][bookmark: 60050]Exporting Connection [bookmark: marker-1558015]Data
 
     [bookmark: pgfId-1609815]License: Any
 
     [bookmark: pgfId-1558018]You can easily share connection data with others by exporting it as a CSV (comma-separated values) file.
 
      
       
     
 
     
 
     [bookmark: pgfId-1558019]Tip You can also save a connection graph as an image by right-clicking on the graph and following your browser’s prompts.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1558020]To export connection data:
 
     [bookmark: pgfId-1616391]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1558022]Step 1 Click Export Data.
 
     [bookmark: pgfId-1558023]A pop-up window appears, displaying a table view of the data on your graph.
 
     [bookmark: pgfId-1558028]Step 2 Click Download CSV File and save the file.
 
     [bookmark: pgfId-1887548]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1555907][bookmark: 62579][bookmark: 98501]Working with Connection and Security Intelligence Data Tables
 
    [bookmark: pgfId-1609836]License: feature dependent
 
    [bookmark: pgfId-1828401]Supported Devices: feature dependent
 
    [bookmark: pgfId-1828405]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1944067]The FireSIGHT System’s event viewer allows you to view connection data in a table, as well as manipulate the event view depending on the information relevant to your analysis. Viewing Security Intelligence events allows you to focus on connections with an identified Security Intelligence reputation. (Security Intelligence requires a Protection license and is not supported on Series 2 managed devices or DC500 Defense Centers.) The page you see when you access connection data differs depending on the workflow, which is simply a series of pages you can use to evaluate events by moving from a broad to a more focused view.
 
     
      
    
 
    
 
    [bookmark: pgfId-1972161]Note The information available for any individual connection or Security Intelligence event depends on several factors, including licenses and appliance model. For more information, see License and Model Requirements for Connection Logging.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1751963]The system-provided Connection Events and Security Intelligence Events workflows provide summary views of basic connection and detected application information, which you can then use to drill down to the table view of events.You can also create a custom workflow that displays only the information that matches your specific needs.
 
    [bookmark: pgfId-1750495]Using the event viewer, you can:
 
     
     	 [bookmark: pgfId-1751956]search for, sort, and constrain events, as well as change the time range for displayed events
 
     	 [bookmark: pgfId-1751957]specify the columns that appear (table view only)
 
     	 [bookmark: pgfId-1751949]view the host profile associated with an IP address, or the user details and host history associated with a user identity
 
     	 [bookmark: pgfId-1751998]view files (including malware files) and intrusions detected in connections
 
     	 [bookmark: pgfId-1785388]view geolocation information associated with an IP address
 
     	 [bookmark: pgfId-1805513]view the full text of a URL in a connection event
 
     	 [bookmark: pgfId-1916373]view information about the certificate used to encrypt a session
 
     	 [bookmark: pgfId-1916374]view encrypted session details
 
     	 [bookmark: pgfId-1750497]view events using different workflow pages within the same workflow
 
     	 [bookmark: pgfId-1750498]view events using a different workflow altogether
 
     	 [bookmark: pgfId-1750499]drill down page-to-page within a workflow, constraining on specific values
 
     	 [bookmark: pgfId-1750500]bookmark the current page and constraints so you can return to the same data (assuming the data still exists) at a later time
 
     	 [bookmark: pgfId-1750501]create a report template using the current constraints
 
     	 [bookmark: pgfId-1750502]delete events from the database
 
     	 [bookmark: pgfId-1805499]use the IP address context menu to whitelist, blacklist, or obtain additional information about a host or IP address associated with a connection
 
    
 
    [bookmark: pgfId-1805500]Note that when you constrain connection events on a drill-down page, the packets and bytes from identical events are summed. However, if you are using a custom workflow and did not add a Count column to a drill-down page, the events are listed individually and packets and bytes are not summed.
 
    [bookmark: pgfId-1763014]Note that the Connection Events table view displays 1 of Many instead of how many pages of events are available if your system generates more than 25 connection events.
 
    [bookmark: pgfId-1994448]The following sections contain information on viewing and analyzing connection and Security Intelligence event tables:
 
     
     	 [bookmark: pgfId-1753375]Understanding and Using Workflows provides detailed instructions on using the event viewer.
 
     	 [bookmark: pgfId-1785792]Using Geolocation provides information on how to view and interpret geolocation information associated with connection and Security Intelligence events.
 
     	 [bookmark: pgfId-1773081]Configuring Event View Settings explains how to change the default workflow for viewing connection and Security Intelligence event data.
 
     	 [bookmark: pgfId-1773145]Understanding Connection and Security Intelligence Data Fields and Information Available in Connection and Security Intelligence Events provide details on the data in connection and Security Intelligence events.
 
     	 [bookmark: pgfId-1773036]Working with Events Associated with Monitor Rules explains how to constrain connection events using Monitor rule criteria.
 
     	 [bookmark: pgfId-1752663]Viewing Files Detected in a Connection explains how to view the files, including malware files, detected or blocked in a connection.
 
     	 [bookmark: pgfId-1916382]Viewing Intrusion Events Associated with a Connection explains how to view the intrusion events associated with a connection.
 
     	 [bookmark: pgfId-1916386]Viewing the Certificate Associated with an Encrypted Connection explains how to view details about the certificate used to encrypt a connection.
 
    
 
     
      [bookmark: pgfId-1753651][bookmark: 27377]Working with Events Asso[bookmark: marker-1753650]ciated with Monitor Rules
 
     [bookmark: pgfId-1751136]License: Any
 
     [bookmark: pgfId-1703787]When you view logged connections using the event viewer, the Defense Center displays the access control rule or default action that handled each connection, as well as up to eight Monitor rules matched by each of those connections.
 
     [bookmark: pgfId-1708692]If a connection matched one Monitor rule, the Defense Center displays the name of the rule that handled the connection, followed by the Monitor rule name. If the connection matched more than one Monitor rule, the event viewer displays how many Monitor rules it matched, for example, Default Action + 2 Monitor Rules.
 
     [bookmark: pgfId-1708697]You can constrain connection event views using matched Monitor rules, using either of the following:
 
      
      	 [bookmark: pgfId-1706267]the access control rule or default action that handled the connection
 
      	 [bookmark: pgfId-1706639]any individual Monitor rule matched by a connection
 
     
 
     [bookmark: pgfId-1707017]To constrain connection events using Monitor rule matching:
 
     [bookmark: pgfId-1707375]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1707376]Step 1 Select Analysis > Connections > Events.
 
     [bookmark: pgfId-1707503]The first page of the default connection data workflow appears.
 
     [bookmark: pgfId-1707504]Step 2 Display the workflow you want to use for your analysis. Make sure the drill-down page or table view you are using shows the Access Control Rule field.
 
     [bookmark: pgfId-1706846]Step 3 How do you want to constrain the events?
 
      
       
       	 [bookmark: pgfId-1707808]to constrain on the access control rule or default action that handled the connection, click the rule name or  Default Action .
 
       	 [bookmark: pgfId-1707998]to constrain on the only Monitor rule that matched a logged connection, click the Monitor rule name.
 
       	 [bookmark: pgfId-1708184]to constrain on one of several Monitor rules that matched a logged connection, click an  N   Monitor Rules value. For example, click  2 Monitor Rules . 
 
      
 
     
 
     [bookmark: pgfId-1839053]The Monitor Rules pop-up window for that connection event appears, listing the first eight Monitor rules matched by the connection. Click the Monitor rule name you want to use to constrain connection events.
 
     [bookmark: pgfId-1708133]Your events are constrained. If you were using a drill-down page, the event view advances to the next page in the workflow.
 
     [bookmark: pgfId-1887554]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1744079][bookmark: 93594]Viewing Files Detecte[bookmark: marker-1777033]d in a Connection
 
     [bookmark: pgfId-1757988]License: Protection or Malware
 
     [bookmark: pgfId-1800467]Supported Devices: feature dependent
 
     [bookmark: pgfId-1800488]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1759552]If you associate a file policy with one or more access control rules, the system can detect files (including malware) in matching traffic. Using the event viewer, you can see the file events, if any, associated with the connections logged by those rules.
 column. The number on the icon indicates the number of files (including malware files) detected or blocked in that connection. Clicking on the icon does not drill down to the next workflow page or constrain connection events. Instead, it displays a pop-up window with a list of the files detected in the connection as well as their types, and if applicable, their malware dispositions. 
     
 
     [bookmark: pgfId-1759704]In the pop-up window, you can click:
 
      
      	 [bookmark: pgfId-1764163]a file’s view icon (
 
      [image: ] ) to view details in a table view of file events 
     
 
      
      	 [bookmark: pgfId-1764167]a malware file’s view icon (
 
      [image: ] ) to view details in a table view of malware events 
     
 
      
      	 [bookmark: pgfId-1779785]a file’s trajectory icon (
 
      [image: ] ) to track the file’s transmission through your network 
     
 
      
      	 [bookmark: pgfId-1764189] View File Events or  View Malware Events to view details on all of the connection’s detected file or network-based malware events
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1759708]Tip To quickly view file or malware events associated with one or more connections, select the connections using the check boxes in the event viewer, then select Malware Events or File Events from the Jump to drop-down list. You can view the connections used to transmit files in a similar way. For more information, see Navigating Between Workflows.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1759712]When you view associated events, the Defense Center uses your default workflow for that event type. For more information on file and malware events, see Working with File Events and Working with Malware Events. For more information on using the network file trajectory feature, see Working with Network File Trajectory. 
 
     [bookmark: pgfId-1767647]Note that not all file and malware events are associated with connections, as follows:
 
      
      	 [bookmark: pgfId-1767862]Endpoint-based malware events are not associated with connections. Those events are generated by FireAMP Connectors, instead of by the system inspecting network traffic.
 
      	 [bookmark: pgfId-1769080]Many IMAP-capable email clients use a single IMAP session, which ends only when the user exits the application. Although long-running connections are logged by the system (see Long-Running Connections), files downloaded in the session are not associated with the connection until the session ends. 
 
     
 
     [bookmark: pgfId-1800531]Note also that Series 2 and Cisco NGIPS for Blue Coat X-Series devices and the DC500 Defense Center do not support network-based advanced malware protection. 
 
    
 
     
      [bookmark: pgfId-1759337][bookmark: 24284]Viewing Intrusion Events Associate[bookmark: marker-1776305]d with a Connection
 
     [bookmark: pgfId-1759338]License: Protection
 
     [bookmark: pgfId-1760573]If you associate an intrusion policy with an access control rule or default action, the system can detect exploits in matching traffic. Using the event viewer, you can see the intrusion events, if any, associated with logged connections.
 column. Clicking on the icon does not drill down to the next workflow page or constrain connection events. Instead, it displays a pop-up window with a list of the intrusion events associated with the connection, as well as their priority and impact. 
     
 to view details on all of the connection’s associated intrusion events. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1760588]Tip To quickly view intrusion events associated with one or more connections, select the connections using the check boxes in the event viewer, then select Intrusion Events from the Jump to drop-down list. You can view the connections associated with intrusion events in a similar way. For more information, see Navigating Between Workflows.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1761422]When you view associated events, the Defense Center uses your default intrusion events workflow. For more information on intrusion events, see Working with Intrusion Events.
 
    
 
     
      [bookmark: pgfId-1916392][bookmark: 79578]Viewing the Certificate Associated with an Encrypted Connection
 
     [bookmark: pgfId-1916399]License: Any
 
     [bookmark: pgfId-1916401]If you configure SSL inspection, you can log encrypted connections. Using the event viewer, you can view details of the public key certificate used to encrypt a connection if the system acted on the traffic and the certificate is available.
 column. Clicking on the icon displays a pop-up window with the certificate details described in the following table. 
     
 
     [bookmark: pgfId-1916449]
 
      
       
        
        [bookmark: pgfId-1916414]Table 39-7 Encrypted Connection Certificate Details 
 
        
        
         
         	 
           
           [bookmark: pgfId-1916418]Attribute 
          
  
         	 
           
           [bookmark: pgfId-1916420]Description 
          
  
        
 
         
         	[bookmark: pgfId-1916422]Subject/Issuer Common Name
  
         	[bookmark: pgfId-1916424]The host and domain name of the certificate subject or certificate issuer. 
  
        
 
         
         	[bookmark: pgfId-1916426]Subject/Issuer Organization
  
         	[bookmark: pgfId-1916428]The organization of the certificate subject or certificate issuer.
  
        
 
         
         	[bookmark: pgfId-1916430]Subject/Issuer Organization Unit
  
         	[bookmark: pgfId-1916432]The organizational unit of the certificate subject or certificate issuer.
  
        
 
         
         	[bookmark: pgfId-1916434]Not Valid Before/After
  
         	[bookmark: pgfId-1916436]The dates when the certificate is valid.
  
        
 
         
         	[bookmark: pgfId-1916438]Serial Number
  
         	[bookmark: pgfId-1916440]The serial number assigned by the issuing CA.
  
        
 
         
         	[bookmark: pgfId-1916442]Certificate Fingerprint
  
         	[bookmark: pgfId-1916444]The SHA hash value used to authenticate the certificate.
  
        
 
         
         	[bookmark: pgfId-1916446]Public Key Fingerprint
  
         	[bookmark: pgfId-1916448]The SHA hash value used to authenticate the public key contained within the certificate.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1916450]You can expand or collapse sections in the pop-up window by double-clicking the heading.
 
     [bookmark: pgfId-1916451]Note that if the system acted on the encrypted traffic but the certificate is unavailable, the lock icon is grayed out. For example, if the system blocked a connection because it contained an SSL handshake error and the system could not decrypt it, then the system would not have encryption certificate details, and the lock icon for that connection is grayed out. 
 
    
 
   
 
    
     [bookmark: pgfId-1805479][bookmark: 73066]Searchin[bookmark: marker-1805477]g for Connection and Security Intelligence Data
 
    [bookmark: pgfId-1805481]License: Any
 
    [bookmark: pgfId-1754075]Using the Defense Center’s Search page, you can search for specific connection events, Security Intelligence events, or connection summaries; display the results in the event viewer; and save your search criteria to reuse later. Custom Analysis dashboard widgets, report templates, and custom user roles can also use saved searches. 
 
    [bookmark: pgfId-1754573]Searches delivered with the system, labeled with (Cisco) in the Saved Searches list, serve as examples.
 
    [bookmark: pgfId-1754665]Because connection graphs are based on connection summaries, the same criteria that constrain connection summaries also constrain connection graphs. Fields marked with an asterisk (*) constrain connection graphs and connection summaries, as well as individual connection or Security Intelligence events.
 
    [bookmark: pgfId-1754609]If you search connection summaries using invalid search constraints and view your results using a connection summary page in a custom workflow, the invalid constraints are labeled as not applicable (N/A) and are marked with a strikethrough, as shown in the following graphic.
 
    [bookmark: pgfId-1999500]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1755016]Also, keep in mind that your search results depend on the available data in the events you are searching. In other words, depending on the available data, your search constraints may not apply. See Information Available in Connection and Security Intelligence Events for information on when data is available for each connection data field.
 
    [bookmark: pgfId-1754084]General Search Syntax
 
    [bookmark: pgfId-1754085]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
     
     	 [bookmark: pgfId-1754086]All fields accept negation ( ! ).
 
     	 [bookmark: pgfId-1936128]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
     	 [bookmark: pgfId-1936129]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
    
 
    [bookmark: pgfId-1936130] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
    [bookmark: pgfId-1936131] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
    [bookmark: pgfId-1936132] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
     
     	 [bookmark: pgfId-1936133]Searches return only records that match the search criteria specified for all fields.
 
     	 [bookmark: pgfId-1754088]Many fields accept one or more asterisks ( * ) as wild cards.
 
     	 [bookmark: pgfId-1754089]Specify  n/a in any field to identify events where information is not available for that field; use  !n/a to identify the events where that field is populated.
 
     	 [bookmark: pgfId-1963786]Use the device field to search for specific devices as well as devices in groups, stacks, or clusters. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
     	 [bookmark: pgfId-1754093]Click the add object icon (
 
     [image: ] ) that appears next to a search field to use an object as a search criterion. 
    
 
    [bookmark: pgfId-1754094]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
    [bookmark: pgfId-1754098][bookmark: 75521]Special Search Syntax for Connection and Security Intelligence Data
 
    [bookmark: pgfId-1755346]To supplement the general search syntax listed above, the following list describes some special search syntax for connection and Security Intelligence data.
 
    [bookmark: pgfId-1936224]A Monitor rule matched by the connection
 
    [bookmark: pgfId-1936283]Use the Access Control Rule criterion to search for connections that matched individual Monitor rules.
 
    [bookmark: pgfId-1936301]Because traffic matching a Monitor rule is always later handled by another rule or by the default action, you cannot search for a connection with an action of Monitor. Searching for the name of a Monitor rule returns all connections that matched that Monitor rule, regardless of the rule or default action that later handled the connection.
 
    [bookmark: pgfId-1936316]A Criterion with a numerical value (Bytes, Packets, Connections)
 
    [bookmark: pgfId-1936486]You can precede the number with greater than (>), greater than or equal to (>=), less than (<), less than or equal to (<=), or equal to (=).
 
     
      
    
 
    
 
    [bookmark: pgfId-1936504]Tip To view meaningful results for searches using the Connections criterion, you must use a custom workflow that has a connection summary page.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1936546]Files or Intrusion Events associated with the connection
 
    [bookmark: pgfId-1936571]You cannot use the connection/Security Intelligence events Search page to search for file, malware, and intrusion events associated with a connection. For information on viewing these associated events, see Viewing Files Detected in a Connection and Viewing Intrusion Events Associated with a Connection. 
 
    [bookmark: pgfId-1936617]The Initiator User or URL for a connection
 
    [bookmark: pgfId-1936610]The system performs a partial match, that is, you can search for all or part of the field contents without using asterisks.
 
    [bookmark: pgfId-1936647]The total Traffic (in bytes) or transport Protocol used in the connection
 
    [bookmark: pgfId-1936682]To determine if there is a protocol or traffic constraint on a connection table view, expand the search constraints.
 
    [bookmark: pgfId-1936722]To search for a specific protocol, use the name or number protocol as listed in http://www.iana.org/assignments/protocol-numbers.
 
    [bookmark: pgfId-1937704]These columns do not appear in table views. 
 
    [bookmark: pgfId-1936748]TCP Flags in a NetFlow connection
 
    [bookmark: pgfId-1936709]Type a list of comma-separated TCP flags to view all connections that have at least one of those flags (instead of all). You can also select the Only check box to search for connections that have any of the flags you specify as their only TCP flag.
 
    [bookmark: pgfId-1936804]SSL Encryption applied to the connection
 
    [bookmark: pgfId-1936841]Type yes or no to view SSL-encrypted or non-encrypted connections. 
 
    [bookmark: pgfId-1937776]This column does not appear in Security Intelligence or connection events table views. 
 
    [bookmark: pgfId-1936864]The SSL Status
 
    [bookmark: pgfId-1960555]Type one or more of the keywords listed for SSL Actual Action and SSL Failure Reason to view encrypted traffic to which the system applied an action or encountered a condition. This field may simultaneously contain one SSL Actual Action value and SSL Failure Reason value.
 
    [bookmark: pgfId-1961353]When decryption is successful, the Security Intelligence and connection event table views display the value for SSL Actual Action in the SSL Status column. When the system fails to decrypt traffic, the Security Intelligence and connection event table views display the values for both SSL Actual Action and SSL Failure Reason in the SSL Status column.
 
    [bookmark: pgfId-1960525]The SSL Actual Action taken
 
    [bookmark: pgfId-1936894]Type any of the following keywords to view encrypted traffic to which the system applied the action specified:
 
    [bookmark: pgfId-1936921] – Do Not Decrypt represents connections the system did not decrypt.
 
    [bookmark: pgfId-1936939] – Block and Block with Reset represent blocked encrypted connections.
 
    [bookmark: pgfId-1936954] – Decrypt (Known Key) represents incoming connections decrypted using a known private key.
 
    [bookmark: pgfId-1936977] – Decrypt (Replace Key) represents outgoing connections decrypted using a self-signed server certificate with a substituted public key.
 
    [bookmark: pgfId-1937980] – Decrypt (Resign) represents outgoing connections decrypted using a re-signed server certificate.
 
    [bookmark: pgfId-1937981]When decryption is successful, the Security Intelligence and connection event table views display this value in the SSL Status column. When the system fails to decrypt traffic, the Security Intelligence and connection event table views display this value with the SSL Failure Reason in the SSL Status column.
 
    [bookmark: pgfId-1937028]The SSL Expected Action
 
    [bookmark: pgfId-1938279]Type any of the following keywords to view encrypted traffic that the system was expected to process in the manner specified given the SSL rules in effect:
 
    [bookmark: pgfId-1937078] – Do Not Decrypt represents connections the system did not decrypt.
 
    [bookmark: pgfId-1937079] – Block and Block with Reset represent blocked encrypted connections.
 
    [bookmark: pgfId-1937080] – Decrypt (Known Key) represents incoming connections decrypted using a known private key.
 
    [bookmark: pgfId-1937081] – Decrypt (Replace Key) represents outgoing connections decrypted using a self-signed server certificate with a substituted public key.
 
    [bookmark: pgfId-1937082] – Decrypt (Resign) represents outgoing connections decrypted using a re-signed server certificate.
 
    [bookmark: pgfId-1937074]This column does not appear in Security Intelligence or connection events table views.
 
    [bookmark: pgfId-1937146]The SSL Failure Reason
 
    [bookmark: pgfId-1937184]Type any of the following keywords to view encrypted traffic that the system failed to decrypt for the reason specified:
 
    [bookmark: pgfId-1937297] – Unknown
 
    [bookmark: pgfId-1937298] – No Match
 
    [bookmark: pgfId-1937299] – Success
 
    [bookmark: pgfId-1937300] – Uncached Session
 
    [bookmark: pgfId-1937301] – Unknown Cipher Suite
 
    [bookmark: pgfId-1937302] – Unsupported Cipher Suite
 
    [bookmark: pgfId-1937303] – Unsupported SSL Version
 
    [bookmark: pgfId-1937304] – SSL Compression Used
 
    [bookmark: pgfId-1937305] – Session Undecryptable in Passive Mode
 
    [bookmark: pgfId-1937306] – Handshake Error
 
    [bookmark: pgfId-1937307] – Decryption Error
 
    [bookmark: pgfId-1937308] – Pending Server Name Category Lookup
 
    [bookmark: pgfId-1937309] – Pending Common Name Category Lookup
 
    [bookmark: pgfId-1937310] – Internal Error
 
    [bookmark: pgfId-1937311] – Network Parameters Unavailable
 
    [bookmark: pgfId-1937312] – Invalid Server Certificate Handle
 
    [bookmark: pgfId-1937313] – Server Certificate Fingerprint Unavailable
 
    [bookmark: pgfId-1937314] – Cannot Cache Subject DN
 
    [bookmark: pgfId-1937315] – Cannot Cache Issuer DN
 
    [bookmark: pgfId-1937316] – Unknown SSL Version
 
    [bookmark: pgfId-1937317] – External Certificate List Unavailable
 
    [bookmark: pgfId-1937318] – External Certificate Fingerprint Unavailable
 
    [bookmark: pgfId-1937319] – Internal Certificate List Invalid
 
    [bookmark: pgfId-1937320] – Internal Certificate List Unavailable
 
    [bookmark: pgfId-1937321] – Internal Certificate Unavailable
 
    [bookmark: pgfId-1937322] – Internal Certificate Fingerprint Unavailable
 
    [bookmark: pgfId-1937323] – Server Certificate Validation Unavailable
 
    [bookmark: pgfId-1937324] – Server Certificate Validation Failure
 
    [bookmark: pgfId-1937325] – Invalid Action
 
    [bookmark: pgfId-1938535]When the system fails to decrypt traffic, the Security Intelligence and connection event table views display this value with the SSL Actual Action in the SSL Status column.
 
    [bookmark: pgfId-1937136]The SSL Cipher Suite used
 
    [bookmark: pgfId-1960962]Type a macro value representing a cipher suite used to encrypt the connection. See www.iana.org/assignments/tls-parameters/tls-parameters.xhtml for cipher suite value designations.
 
    [bookmark: pgfId-1960923]The SSL Subject Country
 
    [bookmark: pgfId-1937378]Type a two-character ISO 3166-1 alpha-2 country code to view encrypted traffic associated with the encryption certificate subject country. 
 
    [bookmark: pgfId-1938596]This column does not appear in Security Intelligence or connection events table views.
 
    [bookmark: pgfId-1937406]The SSL Issuer Country
 
    [bookmark: pgfId-1937431]Type a two-character ISO 3166-1 alpha-2 country code to view encrypted traffic associated with the encryption certificate subject country. 
 
    [bookmark: pgfId-1938609]This column does not appear in Security Intelligence or connection events table views.
 
    [bookmark: pgfId-1937481]SSL Certificate Fingerprint
 
    [bookmark: pgfId-1937482]Type or paste the SHA hash value used to authenticate a certificate to view traffic associated with that certificate.
 
    [bookmark: pgfId-1940777]This column does not appear in Security Intelligence or connection events table views.
 
    [bookmark: pgfId-1937483]SSL Public Key Fingerprint
 
    [bookmark: pgfId-1937484]Type or paste the SHA hash value used to authenticate the public key contained within a certificate to view traffic associated with that certificate.
 
    [bookmark: pgfId-1940799]This column does not appear in Security Intelligence or connection events table views.
 
    [bookmark: pgfId-1939190]SSL Certificate Status
 
    [bookmark: pgfId-1956839]This applies only if you configured a Certificate Status rule condition. Type one or more of the keywords listed below to view encrypted traffic associated with server certificate statuses. Encrypted traffic may match multiple server certificate status values simultaneously.
 
    [bookmark: pgfId-1939418] – Not Checked
 
    [bookmark: pgfId-1939441] – Self Signed
 
    [bookmark: pgfId-1939459] – Valid
 
    [bookmark: pgfId-1939470] – Invalid Signature
 
    [bookmark: pgfId-1939494] – Invalid Issuer
 
    [bookmark: pgfId-1939514] – Expired
 
    [bookmark: pgfId-1978310] – Unknown
 
    [bookmark: pgfId-1939523] – Not Valid Yet
 
    [bookmark: pgfId-1939538] – Revoked
 
    [bookmark: pgfId-1939403]SSL Flow Messages
 
    [bookmark: pgfId-1939603]Type any of the following keywords to view encrypted traffic associated with the following messages exchanged between client and server during the SSL handshake:
 
    [bookmark: pgfId-1939731] – HELLO_REQUEST
 
    [bookmark: pgfId-1939757] – CLIENT_ALERT
 
    [bookmark: pgfId-1939771] – SERVER_ALERT
 
    [bookmark: pgfId-1939785] – CLIENT_HELLO
 
    [bookmark: pgfId-1939799] – SERVER_HELLO
 
    [bookmark: pgfId-1939815] – SERVER_CERTIFICATE
 
    [bookmark: pgfId-1939835] – SERVER_KEY_EXCHANGE
 
    [bookmark: pgfId-1940076] – CERTIFICATE_REQUEST
 
    [bookmark: pgfId-1940097] – SERVER_HELLO_DONE
 
    [bookmark: pgfId-1940119] – CLIENT_CERTIFICATE
 
    [bookmark: pgfId-1940139] – CLIENT_KEY_EXCHANGE
 
    [bookmark: pgfId-1939856] – CERTIFICATE_VERIFY
 
    [bookmark: pgfId-1939876] – CLIENT_CHANGE_CIPHER_SPEC
 
    [bookmark: pgfId-1939902] – CLIENT_FINISHED
 
    [bookmark: pgfId-1939919] – SERVER_CHANGE_CIPHER_SPEC
 
    [bookmark: pgfId-1939955] – SERVER_FINISHED
 
    [bookmark: pgfId-1939972] – NEW_SESSION_TICKET
 
    [bookmark: pgfId-1939999] – HANDSHAKE_OTHER
 
    [bookmark: pgfId-1940016] – APP_DATA_FROM_CLIENT
 
    [bookmark: pgfId-1940038] – APP_DATA_FROM_SERVER
 
    [bookmark: pgfId-1940221]SSL Version
 
    [bookmark: pgfId-1940248]Type any of the following keywords to view encrypted traffic associated with the specified SSL or TLS protocol version:
 
    [bookmark: pgfId-1940306] – Unknown
 
    [bookmark: pgfId-1940326] – SSLv2.0
 
    [bookmark: pgfId-1940335] – SSLv3.0
 
    [bookmark: pgfId-1940344] – TLSv1.0
 
    [bookmark: pgfId-1940368] – TLSv1.1
 
    [bookmark: pgfId-1940382] – TSLv1.2
 
    [bookmark: pgfId-1957430]SSL Serial Number
 
    [bookmark: pgfId-1957464]Type or paste the serial number assigned to the public key certificate by the issuing CA. 
 
    [bookmark: pgfId-1957802]This column does not appear in Security Intelligence or connection events table views.
 
    [bookmark: pgfId-1552256]To search for connection or Security Intelligence data:
 
    [bookmark: pgfId-1616435]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-1919034]Step 1 Select Analysis > Search.
 
    [bookmark: pgfId-1919035]The Search page appears.
 
    [bookmark: pgfId-1919036]Step 2 You have the following options:
 
     
      
      	 [bookmark: pgfId-1919037]Select  Connection Events from the table drop-down list to search for connection data.
 
      	 [bookmark: pgfId-1919038]Select  Security Intelligence Events from the table drop-down list to search for Security Intelligence data.
 
     
 
    
 
    [bookmark: pgfId-1919039]The page updates with the appropriate constraints.
 
    [bookmark: pgfId-1919042]Step 3 Enter your search criteria in the appropriate fields:
 
     
      
      	 [bookmark: pgfId-1919046]See Understanding Connection and Security Intelligence Data Fields for information on the fields in the connection and Security Intelligence events tables.
 
      	 [bookmark: pgfId-1919561]See Viewing the Certificate Associated with an Encrypted Connection for information on fields related to public key certificates.
 
      	 [bookmark: pgfId-1919655]See Special Search Syntax for Connection and Security Intelligence Data for special search syntax for connection and Security Intelligence events.
 
     
 
    
 
    [bookmark: pgfId-1919047]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
     
      
    
 
    
 
    [bookmark: pgfId-1919048]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1919049]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
     
      
      	 [bookmark: pgfId-1938975]Click  Save to save the search criteria.
 
     
 
    
 
    [bookmark: pgfId-1938976]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     
      
      	 [bookmark: pgfId-1938977]Click  Save as New  to save a new search or assign a name to a search you created by altering a previously-saved search. 
 
     
 
    
 
    [bookmark: pgfId-1938978]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
    [bookmark: pgfId-1938842]Step 6 Click Search to start the search.
 
    [bookmark: pgfId-1919051]Your search results appear in your default connection or Security Intelligence workflow, constrained by the current time range.
 
    [bookmark: pgfId-1887592]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1517331][bookmark: 50648][bookmark: 74671]Viewing the [bookmark: marker-1517330]Connection Sum[bookmark: marker-1671682]mary Page
 
    [bookmark: pgfId-1609870]License: Any
 
    [bookmark: pgfId-1580498]The [bookmark: marker-1517342]Connection Summary page provides graphs of the activity on your monitored network organized by different criteria. For example, the Connections over Time graph displays the total number of connections on your monitored network over the interval that you select.
 
     
      
    
 
    
 
    [bookmark: pgfId-1580604]Note The Connection Summary page is visible only to users who have custom roles that are restricted by searches on connection events and who have been granted explicit access to the Connection Summary page. For more information, see Understanding Restricted User Access Properties and Managing Custom User Roles.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1521950]Table 39-8 [bookmark: 42587]Connection Summary Page Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-1521954]To... 
         
  
        	 
          
          [bookmark: pgfId-1521956]You can... 
         
  
       
 
        
        	[bookmark: pgfId-1521958]modify the time and date range for the Connection Summary page
  
        	[bookmark: pgfId-1521962]find more information in Setting Event Time Constraints.
  
       
 
        
        	[bookmark: pgfId-1521965]manipulate connection graphs
  
        	[bookmark: pgfId-1521969]find more information in Working with Connection Graphs.
  
       
 
        
        	[bookmark: pgfId-1521979]detach a connection graph from the page
  
        	[bookmark: pgfId-1521981]click View on the graph you want to detach. For more information on detached graphs, see Detaching Connection Graphs.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1521986]You can perform almost all the same actions on connection summary graphs that you can perform on connection graphs. However, because the graphs on the Connection Summary page are based on aggregated data, you cannot examine the individual connection events on which the graphs are based. In other words, you cannot drill down to a connection data table view from a connection summary graph.
 
    [bookmark: pgfId-1517460]To view the Connection Summary page:
 
    [bookmark: pgfId-1517461]Access: Custom
 
    
 
    [bookmark: pgfId-1517462]Step 1 Select Overview > Summary > Connection Summary.
 
    [bookmark: pgfId-1517465]The Connection Summary page appears for the current time range on your Defense Center.
 
    [bookmark: pgfId-1517467]Step 2 From the Select Device list, select the device whose summary you want to view, or select All to view a summary of all devices.
 
    [bookmark: pgfId-1887606]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1515003]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1871080][bookmark: 19929]Analyzing Malware and File Activity 
      
      
 
     
 
 
    [bookmark: pgfId-2046941]The Defense Center logs records of the system’s file inspection and handling as captured files, file events, and malware events:
 
     
     	 [bookmark: pgfId-2046942] Captured files represent files that the system captured.
 
     	 [bookmark: pgfId-2046943] File events represent files that the system detected, and optionally blocked, in network traffic.
 
     	 [bookmark: pgfId-2046944] Malware events represent malware files detected, and optionally blocked, in network traffic by the system.
 
     	 [bookmark: pgfId-2046946] Retrospective malware events [bookmark: marker-2046945] represent files whose malware file dispositions have changed.
 
    
 
    [bookmark: pgfId-2046948]Wh[bookmark: marker-2046947]en the system generates a malware event based on detection or blocking of malware in network traffic, it also generates a file event, because to detect malware in a file, the system must first detect the file itself. Note that endpoint-based malware events generated by FireAMP Connectors (see Integrating FireAMP with the FireSIGHT System) do not have corresponding file events. Similarly, when the system captures a file in network traffic, it also generates a file event because the system first detected the file.
 
    [bookmark: pgfId-2046958]You can use the Defense Center to view, manipulate, and analyze captured files, file events, and malware events, then communicate your analysis to others. The Context Explorer, dashboards, event viewer, context menu, network file trajectory map, and reporting features can give you a deeper understanding of the files and malware detected, captured, and blocked. You can also use events to trigger correlation policy violations, or alert you via email, SMTP, or syslog. 
 
    [bookmark: pgfId-2046934]Because you cannot use a Malware license with a DC500 or enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to generate or analyze captured files, file events, and malware events associated with malware cloud lookups or with the contents of archive files.
 
    [bookmark: pgfId-1962346]For more information, see:
 
     
     	 [bookmark: pgfId-1924905]Working with File Storage
 
     	 [bookmark: pgfId-1924911]Working with Dynamic Analysis
 
     	 [bookmark: pgfId-1663122]Working with File Events
 
     	 [bookmark: pgfId-1624169]Working with Malware Events
 
     	 [bookmark: pgfId-1901984]Working with Captured Files
 
     	 [bookmark: pgfId-1706180]Working with Network File Trajectory
 
    
 
    [bookmark: pgfId-2046758]For information on configuring your system to perform the malware protection and file control actions that produce the data discussed in this chapter, see Blocking Malware and Prohibited Files.
 
   
 
    
     [bookmark: pgfId-2042602][bookmark: 53698]Working with File Storage
 
    [bookmark: pgfId-2042606]License: Malware
 
    [bookmark: pgfId-1915970]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-1915971]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-2044494]Based on your file policy configuration, you can use the file control feature to detect and block files. However, files originating from a suspicious host or network, or an excess of files sent to a monitored host on your network, may require further analysis. The file storage feature allows you to capture selected files detected in traffic, and automatically store them to a device’s hard drive or, if installed, the malware storage pack.
 
    [bookmark: pgfId-1990686]When a device detects a file in traffic, it can [bookmark: marker-2014751]capture that file. This creates a copy the system can either store or submit for dynamic analysis. After your device captures the files, you have several options:
 
     
     	 [bookmark: pgfId-1990687]Store captured files on the device’s hard drive for later analysis. See Understanding Captured File Storage for more information.
 
     	 [bookmark: pgfId-2018807]Download the stored file to a local computer for further manual analysis or archival purposes. See Downloading Stored Files to Another Location for more information.
 
     	 [bookmark: pgfId-1990692]Submit captured files to the Collective Security Intelligence Cloud for dynamic analysis. See Working with Dynamic Analysis for more information.
 
    
 
    [bookmark: pgfId-2138474]Note that once a device stores a file, it will not re-capture it if the file is detected in the future and the device still has that file stored.
 
     
      
    
 
    
 
    [bookmark: pgfId-2138487]Note A file detected for the first time ever is assigned a disposition after the Defense Center completes a cloud lookup. The system generates a file event, but cannot store a file unless the file is immediately assigned a disposition.

If a previously undetected file matches a file rule with a Block Malware action, the subsequent cloud lookup immediately returns a disposition, allowing the system to store the file and generate events. 

If a previously undetected file matches a file rule with a Malware Cloud Lookup action, the system generates file events but requires additional time to perform a cloud lookup and return a disposition. Due to this delay, the system cannot store files matching a file rule with a Malware Cloud Lookup action until the second time they are seen on your network.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2138379]Whether the system captures or stores a file, you can:
 
     
     	 [bookmark: pgfId-1991783]Review information about the captured file from the event viewer, including whether the file was stored or submitted for dynamic analysis, file disposition, and threat score, allowing you to quickly review possible malware threats detected on your network. See Working with Captured Files for more information.
 
     	 [bookmark: pgfId-1991664]View the file’s trajectory to determine how it traversed your network and which hosts have a copy. See Analyzing Network File Trajectory for more information.
 
     	 [bookmark: pgfId-1991837]Add the file to the clean list or custom detection list to always treat the file as if it had a clean or malware disposition on future detection. See Working with File Lists for more information.
 
    
 
    [bookmark: pgfId-1990720]You configure file rules in a file policy to capture and store files of a specific type, or with a particular file disposition, if available. After you associate the file policy with an access control policy and apply it to your devices, matching files in traffic are captured and stored. You can also limit the minimum and maximum file sizes to store. See Tuning File and Malware Inspection Performance and Storage and Working with File Rules for more information.
 
    [bookmark: pgfId-1940211]File storage requires sufficient disk space on the device. If the device’s primary hard drive does not have enough space, and you do not have a malware storage pack installed, you cannot store files on the device.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-2013503] 
     Caution Do not attempt to install a hard drive that was not supplied by Cisco in your device. Installing an unsupported hard drive may damage the device. Malware storage pack kits are available for purchase 
     only from Cisco, and are for use 
     only with 8000 Series devices. Contact Support if you require assistance with the malware storage pack. See the 
      FireSIGHT System Malware Storage Pack Guide for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1911764]Note that because you cannot use a Malware license with a DC500 or enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to capture or store files.
 
    [bookmark: pgfId-1919464]For more information, see:
 
     
     	 [bookmark: pgfId-1919518]Understanding Captured File Storage
 
     	 [bookmark: pgfId-1919552]Downloading Stored Files to Another Location
 
    
 
     
      [bookmark: pgfId-1913126][bookmark: 47380]Understanding Captured File [bookmark: marker-2014761]Storage
 
     [bookmark: pgfId-1915996]License: Malware
 
     [bookmark: pgfId-2019019]Supported Devices: 8000 Series
 
     [bookmark: pgfId-1940741]Based on your file policy configuration, your device may store a substantial amount of file data to the hard drive. You can install a malware storage pack in the device; the system stores files to the malware storage pack, allowing more room on the primary hard drive to store events and configuration files. The system periodically deletes older files. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2013396] 
      Caution Do not attempt to install a hard drive that was not supplied by Cisco in your device. Installing an unsupported hard drive may damage the device. Malware storage pack kits are available for purchase 
      only from Cisco, and are for use 
      only with 8000 Series devices. Contact Support if you require assistance with the malware storage pack. See the 
        
      FireSIGHT System 
       Malware Storage Pack Guide for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1981759]Without a malware storage pack installed, when you configure a device to store files, it allocates a set portion of the primary hard drive’s space solely to captured file storage. When you install a malware storage pack in a device and configure the device to store files, the device instead allocates the entire malware storage pack for storing captured files. The device cannot store any other information on the malware storage pack. 
 
     [bookmark: pgfId-1982687]When the allocated space for captured file storage fills to capacity, the system deletes the oldest stored files until the allocated space reaches a system-defined threshold. Based on the number of files stored, you may see a substantial drop in disk usage after the system deletes files.
 
     [bookmark: pgfId-1981789]If a device has already stored files when you install a malware storage pack, the next time you restart the device, any captured files stored on the primary hard drive are moved to the malware storage pack. Any future files the device stores are stored to the malware storage pack. If the device’s primary hard drive does not have enough available space nor an installed malware storage pack, you cannot store files.
 
     [bookmark: pgfId-1944393]Note that you cannot include stored files in system backup files. For more information, see Creating Backup Files.
 
    
 
     
      [bookmark: pgfId-1912042][bookmark: 97701]Downloading Stored Files to Another [bookmark: marker-2014766]Location
 
     [bookmark: pgfId-1916096]License: Malware
 
     [bookmark: pgfId-1978632]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1978633]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1913236]Once a device stores a file, as long as the Defense Center can communicate with that device and it has not deleted the file, you can download the file. You can manually analyze the file, or download it to a local host for long-term storage and analysis. You can download a file from any associated file event, malware event, captured file view, or the file’s trajectory. For more information, see Using the Context Menu and Summary Information.
 
     [bookmark: pgfId-1975771]Because malware is harmful, by default, you must confirm every file download. However, you can disable the confirmation in the file download prompt. To re-enable the confirmation, see File Preferences. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1975908] 
      Caution Cisco strongly recommends you do 
      not download malware, as it can cause adverse consequences. Exercise caution when downloading any file, as it may contain malware. Ensure you have taken any necessary precautions to secure the download destination before downloading files. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1944979]Because files with a disposition of Unknown may contain malware, when you download a file, the system first archives the file in a .zip package. The .zip file name contains the file disposition and file type, if available, and SHA-256 value. You can password-protect the .zip file to prevent accidental unpacking. To edit or remove the default .zip file password, see File Preferences.
 
    
 
   
 
    
     [bookmark: pgfId-1948785][bookmark: 39827]Working with Dynamic [bookmark: marker-2015212]Analysis
 
    [bookmark: pgfId-1916633]License: Malware
 
    [bookmark: pgfId-1978657]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-1978658]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1919337]To increase the accuracy of the cloud, and to provide additional malware analysis and threat identification, you can submit eligible captured files to the Cisco cloud for dynamic analysis. The cloud runs the file in a test environment and, based on the results, returns a threat score and dynamic analysis summary report to the Defense Center. You can also submit eligible files to the cloud for [bookmark: marker-2014894]Spero analysis, which examines the file’s structure to supplement the malware identification.
 
    [bookmark: pgfId-1986824]Submitting a file to the cloud for dynamic analysis depends on the type of file captured, as well as the allowable minimum and maximum file sizes configured in the access control policy. You can submit:
 
     
     	 [bookmark: pgfId-1997700]a file automatically for dynamic analysis if a file rule performs a malware cloud lookup on an executable file and the file disposition is Unknown
 
     	 [bookmark: pgfId-1997878]up to twenty-five files at once manually for dynamic analysis if stored and a supported file type, such as PDFs, Microsoft Office documents, and others
 
    
 
    [bookmark: pgfId-1998430]Once submitted, the files are queued for analysis in the cloud. You can view captured files and a file’s trajectory to determine whether a file has been submitted for dynamic analysis. Note that each time a file is submitted for dynamic analysis, the cloud analyzes the file, even if the first analysis generated results. 
 
    [bookmark: pgfId-1997514]For more information, see Working with File Rules and Submitting Files for Dynamic Analysis.
 
     
      
    
 
    
 
    [bookmark: pgfId-1986831]Note The system checks the cloud for updates to the list of file types eligible for dynamic analysis and the minimum and maximum file sizes you can submit (no more than once a day).
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1919299]The cloud performs dynamic analysis by running the file in a sandbox environment. It returns:
 
     
     	 [bookmark: pgfId-1998659]a t[bookmark: marker-2015217]hreat score, which details the likelihood a file contains malware. 
 
     	 [bookmark: pgfId-1998674]a [bookmark: marker-2015222]dynamic analysis summary report, which details why the cloud assigned the threat score.
 
    
 
    [bookmark: pgfId-1998670]Based on the file policy configuration, you can automatically block files whose threat score falls above a defined threshold. You can also review the dynamic analysis summary report to better identify malware and fine-tune your detection capabilities. 
 
    [bookmark: pgfId-1998491]To supplement dynamic analysis, if a file rule performs a malware cloud lookup on an executable file, you can automatically submit the file for Spero analysis. The cloud examines the executable file’s structure, including metadata and header information, and can identify files as malware. See Understanding Malware Protection and File Control for more information. 
 
    [bookmark: pgfId-1998967]Note that because you cannot use a Malware license with a DC500 or enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to submit files for dynamic analysis or Spero analysis.
 
     
      
    
 
    
 
    [bookmark: pgfId-1998932]Note You can configure your managed devices to submit files to the Cisco cloud via HTTP proxy. To configure physical appliances, see Configuring Management Interfaces for more information. To configure virtual appliances, see http-proxy. Cisco NGIPS for Blue Coat X-Series does not support proxy settings.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2097073]For more information, see:
 
     
     	 [bookmark: pgfId-1919779]Understanding Spero Analysis
 
     	 [bookmark: pgfId-1919818]Submitting Files for Dynamic Analysis
 
     	 [bookmark: pgfId-1919839]Reviewing the Threat Score and Dynamic Analysis Summary
 
    
 
     
      [bookmark: pgfId-1912755][bookmark: 78951]Understanding [bookmark: marker-2014899]Spero Analysis
 
     [bookmark: pgfId-1916663]License: Malware
 
     [bookmark: pgfId-1978676]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1978677]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1916343]Spero analysis supplements analysis of SHA-256 hashes, allowing for more complete identification of malware in executable files. Spero analysis involves the device examining file structural characteristics such as metadata and header information. After generating a Spero signature based on this information, the device submits it to the Spero heuristic engine in the Cisco cloud. Based on the Spero signature, the Spero engine returns whether the file is malware. If so, and the file currently has an unknown file disposition, the system assigns a Malware file disposition. For more information on file dispositions, see Understanding Malware Protection and File Control.
 
     [bookmark: pgfId-1946889]Note that you can only submit executable files for Spero analysis upon detection; you cannot manually submit them later. You can submit the file for Spero analysis without also submitting it for dynamic analysis. For more information, see Working with File Rules.
 
    
 
     
      [bookmark: pgfId-1912997][bookmark: 68908]Submitting Files for [bookmark: marker-2015227]Dynamic Analysis
 
     [bookmark: pgfId-1916693]License: Malware
 
     [bookmark: pgfId-1978695]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1978696]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1976705]From the event viewer context menu or network file trajectory, you can manually submit a file for dynamic analysis. In addition to executable files, you can also submit file types not eligible for automatic submission, such as PDFs, Microsoft Office documents, and others. See Using the Context Menu and Summary Information for more information.
 
     [bookmark: pgfId-1994624]To analyze multiple files after an incident, regardless of file disposition, you can manually submit up to 25 files (of specific types) at a time from the captured file view. This allows you to more quickly analyze a broad range of files and pinpoint the exact causes of the incident. For more information, see Working with Captured Files and Selecting Rows on a Workflow Page.
 
    
 
     
      [bookmark: pgfId-1911166][bookmark: 48740]Reviewing the Threat [bookmark: marker-2015233]Score and Dynamic Analysis Summary
 
     [bookmark: pgfId-1916726]License: Malware
 
     [bookmark: pgfId-1978744]Supported Devices: Any except Series 2 or X-Series
 
     [bookmark: pgfId-1978745]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1916232]After you submit a file for dynamic analysis, the Cisco cloud analyzes a file’s signatures and returns both a threat score and a dynamic analysis summary. These can help you more closely analyze potential malware threats and fine tune your detection strategy.
 
     [bookmark: pgfId-1999774]Threat Scores
 
      
      
 
      
 
      
 
      
 
       
        
        [bookmark: pgfId-1999125]Table 40-1 Threat Score Ratings 
 
        
        
         
         	 
           
           [bookmark: pgfId-1999131]Threat Score 
          
  
         	 
           
           [bookmark: pgfId-1999133]Icon 
          
  
         	 
           
           [bookmark: pgfId-1999135]Rating 
          
  
        
 
         
         	[bookmark: pgfId-1999137]Low
   
         	[bookmark: pgfId-1999141]1-25
  
        
 
         
         	[bookmark: pgfId-1999143]Medium
   
         	[bookmark: pgfId-1999147]26-50
  
        
 
         
         	[bookmark: pgfId-1999149]High
   
         	[bookmark: pgfId-1999153]51-75
  
        
 
         
         	[bookmark: pgfId-1999155]Very High
   
         	[bookmark: pgfId-1999159]76-100
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1999018]The Defense Center caches a file’s threat score locally for the same amount of time as the file’s disposition. If the system later detects these files, it displays the cached threat scores to the user instead of again querying the Cisco cloud. Based on your file policy configuration, you can automatically assign a malware file disposition to any file with a threat score that exceeds the defined malware threshold threat score. For more information, see Creating a File Policy. 
 
     [bookmark: pgfId-1999818]Dynamic Analysis Summary
 
     [bookmark: pgfId-1916239]If a dynamic analysis summary is available, you can click the threat score icon to view it. The dynamic analysis summary describes the various component ratings that comprise the overall threat score assigned by the Vulnerability Research Team (VRT) file analysis, as well as other processes started when the cloud attempted to run the file. 
 
     [bookmark: pgfId-1999857]If multiple reports exist, this summary is based on the most recent report matching the exact threat score. If none match the exact threat score, then the report with the highest threat score is displayed. If more than one report exists, you can select a threat score to view each separate report.
 
     [bookmark: pgfId-1999853]The summary lists each component threat comprising the threat score. Each component threat is expandable to list the VRT’s findings, as well as any processes related to this component threat.
 
     [bookmark: pgfId-1930297]The process tree shows the processes that started when the cloud attempted to run the file. This can help identify whether a file that contains malware is attempting to access processes and system resources beyond what is expected (for example, running a Word document opens Microsoft Word, then starts Explorer, then starts Java). 
 
     [bookmark: pgfId-2019354]Each listed process contains a process identifier and md5 checksum you can use to verify the actual process. The process tree displays processes started as a result of parent processes as child nodes.
 
     [bookmark: pgfId-1929962]From the dynamic analysis summary, you can click View Full Report to view the VRT’s Analysis report, detailing the VRT’s full analysis, including general file information, a more in-depth review of all detected processes, a breakdown of the file analysis, and other relevant information.
 
    
 
   
 
    
     [bookmark: pgfId-1922253][bookmark: 48550]Working with Fi[bookmark: marker-1922252]le Events
 
    [bookmark: pgfId-1697767]License: Protection
 
    [bookmark: pgfId-1697768]The system logs the file events generated when a managed device detects or blocks a file in network traffic, according to the rules in currently applied file policies. Note that when the system generates a file event, the system also logs the end of the associated connection to the Defense Center database, regardless of the logging configuration of the invoking access control rule. For more information, see Understanding and Creating File Policies.
 
     
      
    
 
    
 
    [bookmark: pgfId-1670918]Note Files detected in network traffic and identified [bookmark: marker-1697785]as malware by the FireSIGHT System generate both a file event and a malware event. This is because to detect malware in a file, the system must first detect the file itself. Endpoint-based malware events do not have corresponding file events. For more information, see Working with Malware Events and Working with Captured Files.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1842231]You can use the Defense Center’s event viewer to view, search, and delete file events. Additionally, the Files Dashboard provides an at-a-glance view of detailed information about the files (including malware files) detected on your network, using charts and graphs. Network file trajectory offers a more in-depth view of individual files, providing summary information about the file and how it has moved through the network over time. Using file identification data, you can trigger correlation rules and create reports, the latter using either the predefined Files Report template or a custom report template.
 
    [bookmark: pgfId-1602523]For more information, see:
 
     
     	 [bookmark: pgfId-1602527]Viewing File Events
 
     	 [bookmark: pgfId-1602531]Understanding the File Events Table
 
     	 [bookmark: pgfId-1786971]Using Geolocation
 
     	 [bookmark: pgfId-1812111]Searching for File Events
 
    
 
     
      [bookmark: pgfId-1812132][bookmark: 63678]Viewin[bookmark: marker-1812129]g File Events
 
     [bookmark: pgfId-1602555]License: Protection
 
     [bookmark: pgfId-1602561]The FireSIGHT System’s event viewer allows you to view file events in a table, as well as manipulate the event view depending on the information relevant to your analysis. Note that the information available for any individual file event depends on several factors, including licenses. For more information, see Service Subscriptions. 
 
     [bookmark: pgfId-1602562]The page you see when you access file events differs depending on the workflow, which is simply a series of pages you can use to evaluate events by moving from a broad to a more focused view. The system is delivered with the following predefined workflows for file events:
 
      
      	 [bookmark: pgfId-1602563] File Summary , the default, provides a quick breakdown of the different file event categories and types, along with any associated malware file dispositions.
 
      	 [bookmark: pgfId-1651888] Hosts Receiving Files and  Hosts Sending Files  provide a list of hosts that have received or sent files, grouped by the associated malware dispositions for those files.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1652977]Note File dispositions appear only for files for which the system performed a malware cloud lookup; see File Rule Actions and Evaluation Order.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1652999]You can also create a custom workflow that displays only the information that matches your specific needs. For information on specifying a different default workflow, including a custom workflow, see Configuring Event View Settings.
 
     [bookmark: pgfId-2095158]The FireSIGHT System supports the display and input of file names that use Unicode (UTF-8) characters in all areas of the web interface, including the event viewer, event search, dashboard, Context Explorer, and so on. Note, however, that reports you generate in PDF format do not support Unicode; Unicode file names appear in the PDF report in transliterated form. For more information, see Generating and Viewing Reports. Note also that the SMB protocol converts Unicode file names to printable characters; files you detect over SMB that have Unicode file names appear with periods (.) in place of any unprintable characters.
 
     [bookmark: pgfId-1842224]Using the event viewer, you can:
 
      
      	 [bookmark: pgfId-1842225]search for, sort, and constrain events, as well as change the time range for displayed events
 
      	 [bookmark: pgfId-1652397]specify the columns that appear (table view only)
 
      	 [bookmark: pgfId-1652547]view the host profile associated with an IP address, or the user details and host history associated with a user identity
 
      	 [bookmark: pgfId-1652548]view the connections where specific files were detected
 
      	 [bookmark: pgfId-1652549]view events using different workflow pages within the same workflow
 
      	 [bookmark: pgfId-1602572]view events using a different workflow altogether
 
      	 [bookmark: pgfId-1602573]drill down page-to-page within a workflow, constraining on specific values
 
      	 [bookmark: pgfId-1842216]bookmark the current page and constraints so you can return to the same data (assuming the data still exists) at a later time
 
      	 [bookmark: pgfId-1842217]view the sending and receiving countries and continents for routable IP addresses associated with a file
 
      	 [bookmark: pgfId-1732080]view a file’s trajectory
 
      	 [bookmark: pgfId-1894707]add a file to a file list, download a file, submit a file for dynamic analysis, or view the full text of a file’s SHA-256 value
 
      	 [bookmark: pgfId-1894708]view a file’s Dynamic Analysis Summary report, if available
 
      	 [bookmark: pgfId-2095166]view nested files inside an archive file
 
      	 [bookmark: pgfId-1602575]create a report template using the current constraints
 
      	 [bookmark: pgfId-1602576]delete events from the database
 
      	 [bookmark: pgfId-1602577]use the IP address context menu to whitelist, blacklist, or obtain additional available information about a host or IP address associated with a file event
 
     
 
     [bookmark: pgfId-1602578]For detailed information on using the event viewer, including creating custom workflows, see Understanding and Using Workflows.
 
     [bookmark: pgfId-2141856]To quickly view the con[bookmark: marker-2141855]nections where specific files were detected, select the files using the check boxes in the event viewer, then select Connections Events from the Jump to drop-down list. For more information, see Navigating Between Workflows.
 
     [bookmark: pgfId-2057864]To view file events:
 
     [bookmark: pgfId-2057868]Access: Admin/Any Security Analyst 
 
     
 
     [bookmark: pgfId-2057869]Step 1 Select Analysis > Files > File Events.
 
     [bookmark: pgfId-1602585]The first page of your default file events workflow appears. For information on the columns that appear, see Understanding the File Events Table.
 
     [bookmark: pgfId-2077837]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1602590][bookmark: 39488]Understanding the[bookmark: marker-1697735] File Events Table
 
     [bookmark: pgfId-1602594]License: Protection
 
     [bookmark: pgfId-2047048]The Defense Center logs a file event when a managed device detects or blocks a file being transmitted in monitored network traffic, according to the settings in an applied file policy.
 . 
     
 
     [bookmark: pgfId-2008735]Keep in mind that the information available for any individual file event depends on several factors, including licenses. For example, although you can perform file control with only a Protection license, a Malware license allows you to perform advanced malware protection for certain file types and track files transferred on your network.
 
     [bookmark: pgfId-2077845]The following table describes the file event fields.
 
     [bookmark: pgfId-2008915]
 
      
       
        
        [bookmark: pgfId-2008745]Table 40-2 [bookmark: 43788]File Event Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-2008749]Field 
          
  
         	 
           
           [bookmark: pgfId-2008751]Description 
          
  
        
 
         
         	[bookmark: pgfId-2008753]Time
  
         	[bookmark: pgfId-2008755]The date and time the event was generated.
  
        
 
         
         	[bookmark: pgfId-2008757]Action
  
         	[bookmark: pgfId-2008759]The action associated with the file policy rule that detected the file, and any associated file action options.
  
        
 
         
         	[bookmark: pgfId-2008761]Sending IP
  
         	[bookmark: pgfId-2008763]The IP address of the host sending the detected file.
  
        
 
         
         	[bookmark: pgfId-2008765]Sending Country
  
         	[bookmark: pgfId-2008767]The country of the host sending the detected file.
 [bookmark: pgfId-2008771]Note that the DC500 Defense Center does not support this feature.
  
        
 
         
         	[bookmark: pgfId-2008773]Receiving IP
  
         	[bookmark: pgfId-2008775]The IP address of the host receiving the detected file.
  
        
 
         
         	[bookmark: pgfId-2008777]Receiving Country
  
         	[bookmark: pgfId-2008779]The country of the host receiving the detected file.
 [bookmark: pgfId-2008783]Note that the DC500 Defense Center does not support this feature.
  
        
 
         
         	[bookmark: pgfId-2008785]Sending Port
  
         	[bookmark: pgfId-2008787]The source port used by the traffic where the file was detected.
  
        
 
         
         	[bookmark: pgfId-2008789]Receiving Port
  
         	[bookmark: pgfId-2008791]The destination port used by the traffic where the file was detected.
  
        
 
         
         	[bookmark: pgfId-2047168]SSL Status
  
         	[bookmark: pgfId-2095304]The action associated with the SSL rule, default action, or undecryptable traffic action that logged the encrypted connection:
 
           
           	 [bookmark: pgfId-2095305] Block and  Block with reset represent blocked encrypted connections. 
 
           	 [bookmark: pgfId-2095306] Decrypt (Resign) represents an outgoing connection decrypted using a re-signed server certificate. 
 
           	 [bookmark: pgfId-2095307] Decrypt (Replace Key) represents an outgoing connection decrypted using a self-signed server certificate with a substituted public key.
 
           	 [bookmark: pgfId-2095308] Decrypt (Known Key) represents an incoming connection decrypted using a known private key.
 
           	 [bookmark: pgfId-2095309] Default Action indicates the connection was handled by the default action.
 
           	 [bookmark: pgfId-2095310] Do not Decrypt represents a connection the system did not decrypt.
 
          
 [bookmark: pgfId-2095311]If the system fails to decrypt an encrypted connection, it displays the undecryptable traffic action taken, as well as the failure reason. For example, if the system detects traffic encrypted with an unknown cipher suite and allowed it without further inspection, this field displays Do Not Decrypt (Unknown Cipher Suite).
 ) to view certificate details. For more information, see Viewing the Certificate Associated with an Encrypted Connection.
  
        
 
         
         	[bookmark: pgfId-2008793]User
  
         	[bookmark: pgfId-2008795]The user logged into the host (Receiving IP) where the file was destined. 
 [bookmark: pgfId-2008796]Note that because the user is associated with the destination host, users are not associated with file events where the user uploaded a file.
  
        
 
         
         	[bookmark: pgfId-2008798]File Name
  
         	[bookmark: pgfId-2008800]The name of the file.
  
        
 
         
         	[bookmark: pgfId-2008802]Disposition
  
         	[bookmark: pgfId-2008804]One of the following file dispositions:
 
           
           	 [bookmark: pgfId-2008805] Malware  indicates that the cloud categorized the file as malware, or that the file’s threat score exceeded the malware threshold defined in the file policy.
 
           	 [bookmark: pgfId-2008806] Clean  indicates that the cloud categorized the file as clean, or that a user added the file to the clean list.
 
           	 [bookmark: pgfId-2008807] Unknown  indicates that a malware cloud lookup occurred before the cloud assigned a disposition. The file is uncategorized.
 
           	 [bookmark: pgfId-2008808] Custom Detection indicates that a user added the file to the custom detection list.
 
           	 [bookmark: pgfId-2008812] Unavailable  indicates that the Defense Center could not perform a malware cloud lookup. You may see a small percentage of events with this disposition; this is expected behavior.
 
           	 [bookmark: pgfId-2008813] N/A indicates a Detect Files or Block Files rule handled the file and the Defense Center did not perform a malware cloud lookup.
 
          
  
        
 
         
         	[bookmark: pgfId-2008818]SHA256
  
         	[bookmark: pgfId-2008820]The SHA-256 hash value of the file, as well as a network file trajectory icon representing the most recently detected file event and file disposition, if this file was detected as the result of:
 
           
           	 [bookmark: pgfId-2008821]a Detect Files file rule with  Store Files enabled
 
           	 [bookmark: pgfId-2008822]a Block Files file rule with  Store Files enabled
 
           	 [bookmark: pgfId-2008823]a Malware Cloud Lookup file rule
 
           	 [bookmark: pgfId-2008824]a Block Malware file rule
 
          
 [bookmark: pgfId-2008825]To view the network file trajectory, click the trajectory icon. For more information, see Analyzing Network File Trajectory.
  
        
 
         
         	[bookmark: pgfId-2008830]Threat Score
  
         	[bookmark: pgfId-2008832]The threat score most recently associated with this file: 
 
           
           	 [bookmark: pgfId-2008836] Low (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2008840] Medium (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2008844] High (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2008848] Very High (
 
           [image: ] ) 
          
 [bookmark: pgfId-2008849]To view the Dynamic Analysis Summary report, click the threat score icon.
  
        
 
         
         	[bookmark: pgfId-2008851]Type
  
         	[bookmark: pgfId-2008853]The type of file, for example, HTML or MSEXE.
  
        
 
         
         	[bookmark: pgfId-2008855]Category
  
         	[bookmark: pgfId-2008857]The general categories of file type, for example: Office Documents, Archive, Multimedia, Executables, PDF files, Encoded, Graphics, or System Files.
  
        
 
         
         	[bookmark: pgfId-2008859]Size (KB)
  
         	[bookmark: pgfId-2008861]The size of the file, in kilobytes. Note that if the system determines the file type of a file before the file is fully received, the file size may not be calculated and this field is blank.
  
        
 
         
         	[bookmark: pgfId-2008863]URI
  
         	[bookmark: pgfId-2008865]The originating URI of the file, for example, the URL where a user downloaded it.
  
        
 
         
         	[bookmark: pgfId-2048169]Archive Name
  
         	[bookmark: pgfId-2048171]Name of the archive file (if any) with which the file is associated, for example, archive.zip. To view the contents of an archive file, right-click on the archive file’s event viewer row to open the context menu, then click View Archive Contents. For more information, see Viewing the Contents of Archived Files.
  
        
 
         
         	[bookmark: pgfId-2048165]Archive SHA256
  
         	[bookmark: pgfId-2048167]The SHA-256 hash value of the archive file (if any) with which the file is associated.
  
        
 
         
         	[bookmark: pgfId-2048161]Archive Depth
  
         	[bookmark: pgfId-2048163]The level (if any) at which the file was nested in an archive file, for example, 1 or 3.
  
        
 
         
         	[bookmark: pgfId-2008867]Application Protocol
  
         	[bookmark: pgfId-2008869]The application protocol used by the traffic in which a managed device detected the file.
  
        
 
         
         	[bookmark: pgfId-2008871]Application Protocol, Client, or Web Application Category or Tag
  
         	[bookmark: pgfId-2008873]Criteria that characterize the application to help you understand the application's function; see Table 45-2.
  
        
 
         
         	[bookmark: pgfId-2008878]Client
  
         	[bookmark: pgfId-2008880]The client application used in the connection to transmit a file.
  
        
 
         
         	[bookmark: pgfId-2008882]Web Application
  
         	[bookmark: pgfId-2008884]For files transmitted using HTTP, the web application (content or requested URL) detected in the connection and used to transmit the file.
  
        
 
         
         	[bookmark: pgfId-2008886]Application Risk
  
         	[bookmark: pgfId-2008888]The risk associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated risk; this field displays the highest of those. For more information, see Table 45-2.
  
        
 
         
         	[bookmark: pgfId-2008893]Business Relevance
  
         	[bookmark: pgfId-2008895]The business relevance associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated business relevance; this field displays the lowest (least relevant) of those. For more information, see Table 45-2.
  
        
 
         
         	[bookmark: pgfId-2008900]Message
  
         	[bookmark: pgfId-2008902]For files where a malware disposition has changed, that is, for files associated with retrospective malware events, information about when and how the disposition changed.
  
        
 
         
         	[bookmark: pgfId-2008904]File Policy
  
         	[bookmark: pgfId-2008906]The file policy that detected the file.
  
        
 
         
         	[bookmark: pgfId-2008908]Device
  
         	[bookmark: pgfId-2008910]The name of the device that detected the file.
  
        
 
         
         	[bookmark: pgfId-2047679]Security Context
  
         	[bookmark: pgfId-2047681]The metadata identifying the virtual firewall group through which the traffic passed. Note that the system only populates this field for ASA FirePOWER devices in multiple context mode.
  
        
 
         
         	[bookmark: pgfId-2008912]Count
  
         	[bookmark: pgfId-2008914]The number of events that match the information in each row. This field appears after you apply a constraint that creates two or more identical rows.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1808149][bookmark: 26868]Searc[bookmark: marker-1808147]hing for File Events
 
     [bookmark: pgfId-1808153]License: Protection
 
     [bookmark: pgfId-1681479]Using the Defense Center’s Search page, you can search for specific file events, display the results in the event viewer, and save your search criteria to reuse later. Custom Analysis dashboard widgets, report templates, and custom user roles can also use saved searches.
 
     [bookmark: pgfId-1655065]Keep in mind that your search results depend on the available data in the events you are searching. In other words, depending on the available data, your search constraints may not apply. For example, the Disposition and SHA256 fields are populated only for files for which the Defense Center performed a malware cloud lookup.
 
     [bookmark: pgfId-1617970]General Search Syntax
 
     [bookmark: pgfId-1617971]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-1617972]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-2114464]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-2114465]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-2114466] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-2114467] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-2114468] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-2114469]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-1617974]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-2129722]Specify  n/a in any field to identify events where information is not available for that field; use  !n/a to identify the events where that field is populated.
 
      	 [bookmark: pgfId-2129723]Use the device field to search for specific devices as well as devices in groups, stacks, or clusters. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
      	 [bookmark: pgfId-2129733]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-1617980]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-1617984][bookmark: 32793]Special Search Syntax for File Events
 
     [bookmark: pgfId-1656080]To supplement the general search syntax listed above, the following list describes some special search syntax for file events.
 
     [bookmark: pgfId-2112140]Sending/Receiving Continent
 
     [bookmark: pgfId-2112141]The system returns all events where either the Sending Continent or the Receiving Continent matches the continent you specify.
 
     [bookmark: pgfId-2112142]Sending/Receiving Country
 
     [bookmark: pgfId-2112143]The System returns all events where either the Sending Country or the Receiving Country matches the country you specify.
 
     [bookmark: pgfId-2112144]Sending/Receiving IP
 
     [bookmark: pgfId-2112145]The system returns all events where either the Sending IP or the Receiving IP matches the IP address you specify.
 
     [bookmark: pgfId-2112146]URI or Message
 
     [bookmark: pgfId-2112147]The system performs a partial match, that is, you can search for all or part of the field contents without using asterisks.
 
     [bookmark: pgfId-2114756]File Storage
 
     [bookmark: pgfId-2114757]Type one or more of the following:
 
     [bookmark: pgfId-2114758] – Stored returns all events where the associated file is currently stored.
 
     [bookmark: pgfId-2112151] – Stored in connection returns all events where the system captured and stored the associated file, regardless of whether the associated file is currently stored.
 
     [bookmark: pgfId-2112152] – Failed returns all events where the system failed to store the associated file.
 
     [bookmark: pgfId-2112153]The SSL Actual Action taken
 
     [bookmark: pgfId-2112154]Type any of the following keywords to view file events for encrypted traffic to which the system applied the action specified:
 
     [bookmark: pgfId-2112155] – Do Not Decrypt represents connections the system did not decrypt.
 
     [bookmark: pgfId-2112156] – Block and Block with Reset represent blocked encrypted connections.
 
     [bookmark: pgfId-2112157] – Decrypt (Known Key) represents incoming connections decrypted using a known private key.
 
     [bookmark: pgfId-2112158] – Decrypt (Replace Key) represents outgoing connections decrypted using a self-signed server certificate with a substituted public key.
 
     [bookmark: pgfId-2112159] – Decrypt (Resign) represents outgoing connections decrypted using a re-signed server certificate.
 
     [bookmark: pgfId-2112160]This column does not appear in the file events table view.
 
     [bookmark: pgfId-2112161]The SSL Failure Reason
 
     [bookmark: pgfId-2114542]Type any of the following keywords to view file events for encrypted traffic that the system failed to decrypt for the reason specified: 
 
     [bookmark: pgfId-2114543] – Unknown
 
     [bookmark: pgfId-2114544] – No Match
 
     [bookmark: pgfId-2114545] – Success
 
     [bookmark: pgfId-2114546] – Uncached Session
 
     [bookmark: pgfId-2114547] – Unknown Cipher Suite
 
     [bookmark: pgfId-2114548] – Unsupported Cipher Suite
 
     [bookmark: pgfId-2114549] – Unsupported SSL Version
 
     [bookmark: pgfId-2114550] – SSL Compression Used
 
     [bookmark: pgfId-2114551] – Session Undecryptable in Passive Mode
 
     [bookmark: pgfId-2114552] – Handshake Error
 
     [bookmark: pgfId-2114553] – Decryption Error
 
     [bookmark: pgfId-2114554] – Pending Server Name Category Lookup
 
     [bookmark: pgfId-2114555] – Pending Common Name Category Lookup
 
     [bookmark: pgfId-2114556] – Internal Error
 
     [bookmark: pgfId-2114557] – Network Parameters Unavailable
 
     [bookmark: pgfId-2114558] – Invalid Server Certificate Handle
 
     [bookmark: pgfId-2114559] – Server Certificate Fingerprint Unavailable
 
     [bookmark: pgfId-2114560] – Cannot Cache Subject DN
 
     [bookmark: pgfId-2114561] – Cannot Cache Issuer DN
 
     [bookmark: pgfId-2114562] – Unknown SSL Version
 
     [bookmark: pgfId-2114563] – External Certificate List Unavailable
 
     [bookmark: pgfId-2114564] – External Certificate Fingerprint Unavailable
 
     [bookmark: pgfId-2114565] – Internal Certificate List Invalid
 
     [bookmark: pgfId-2114566] – Internal Certificate List Unavailable
 
     [bookmark: pgfId-2114567] – Internal Certificate Unavailable
 
     [bookmark: pgfId-2114568] – Internal Certificate Fingerprint Unavailable
 
     [bookmark: pgfId-2114569] – Server Certificate Validation Unavailable
 
     [bookmark: pgfId-2114570] – Server Certificate Validation Failure
 
     [bookmark: pgfId-2114571] – Invalid Action
 
     [bookmark: pgfId-2114572]This column does not appear in the file events table view.
 
     [bookmark: pgfId-2112165]The SSL Subject Country
 
     [bookmark: pgfId-2112166]Type a two-character ISO 3166-1 alpha-2 country code to view file events for encrypted traffic associated with the country of a certificate subject. 
 
     [bookmark: pgfId-2114633]This column does not appear in the file events table view.
 
     [bookmark: pgfId-2112167]The SSL Issuer Country
 
     [bookmark: pgfId-2112168]Type a two-character ISO 3166-1 alpha-2 country code to view file events for encrypted traffic associated with the country of a certificate issuer. 
 
     [bookmark: pgfId-2114636]This column does not appear in the file events table view.
 
     [bookmark: pgfId-2114260]SSL Certificate Fingerprint
 
     [bookmark: pgfId-2114295]Type or paste the SHA hash value used to authenticate a certificate to view file events for traffic associated with that certificate.
 
     [bookmark: pgfId-2117636]This column does not appear in the file events table view.
 
     [bookmark: pgfId-2114317]SSL Public Key Fingerprint
 
     [bookmark: pgfId-2114352]Type or paste the SHA hash value used to authenticate the public key contained within a certificate to view file events for traffic associated with that certificate.
 
     [bookmark: pgfId-2117651]This column does not appear in the file events table view.
 
     [bookmark: pgfId-1617991]To search for file events:
 
     [bookmark: pgfId-1617992]Access: Admin/Any Security Analyst 
 
     
 
     [bookmark: pgfId-2099058]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-2099059]The Search page appears.
 
     [bookmark: pgfId-2099060]Step 2 Select File Events from the table drop-down list.
 
     [bookmark: pgfId-2099061]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-2099062]Step 3 Enter your search criteria in the appropriate fields as described in the following sections:
 
      
       
       	 [bookmark: pgfId-2099066]See the  File Event Fields  table for information on the fields in the file events table.
 
       	 [bookmark: pgfId-2102651]See Special Search Syntax for File Events for special search syntax for file events.
 
       	 [bookmark: pgfId-2108006]See Viewing the Certificate Associated with an Encrypted Connection for fields related to public key certificates.
 
      
 
     
 
     [bookmark: pgfId-2099067]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-2099068]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2099069]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-2099072]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-2099073]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-2099074]Click  Save as New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-2099075]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-2115188]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-2115208]Your search results appear in your default file events workflow, constrained by the current time range.
 
     [bookmark: pgfId-2077708]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1602608][bookmark: 91409]Working with Mal[bookmark: marker-1602607]ware Events
 
    [bookmark: pgfId-1677226]License: Malware or Any
 
    [bookmark: pgfId-1783145]Supported Devices: feature dependent
 
    [bookmark: pgfId-1783147]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1662984]The system logs malware events to the Defense Center database when:
 
     
     	 [bookmark: pgfId-1662989]a managed device detects a file in network traffic that is then identified as malware by a malware cloud lookup
 
     	 [bookmark: pgfId-1910341]a managed device detects a file on the custom detection list in network traffic
 
     	 [bookmark: pgfId-1663241]the system learns that a file’s malware disposition has changed; these are called retros[bookmark: marker-1694112]pective malware events
 
     	 [bookmark: pgfId-1846638]a FireAMP Connector installed on an endpoint in your organization detects a threat and communicates that threat to the Cisco cloud
 
    
 
    [bookmark: pgfId-1842206]Because FireAMP malware detection is performed at the endpoint at download or execution time, while managed devices detect files in network traffic, the information in these malware events is different. Retrospective malware events also contain slightly different data than other network-based malware events, or endpoint-based malware events.
 
    [bookmark: pgfId-1783686]The following sections briefly describe the different kinds of malware events. For information on the overall malware detection process, see Understanding Malware Protection and File Control.
 
    [bookmark: pgfId-1783202][bookmark: 71487]Endpoint-[bookmark: marker-1783198]Based (FireAMP) Malware Events
 
    [bookmark: pgfId-1783209]If your organization has a FireAMP subscription, individual users install FireAMP Connect[bookmark: marker-1783210]ors on their computers and mobile devices. These lightweight agents communicate with the Cisco cloud, which in turn communicates with your Defense Center; see Working with Cloud Connections for FireAMP. The cloud can send notification of threats, as well other kinds of information including data on scans, quarantines, blocked executions, and cloud recalls. The Defense Center logs this information to its database as malware events.
 
     
      
    
 
    
 
    [bookmark: pgfId-1671408]Note The IP addresses reported in endpoint-based malware events may not be in your network map—and may not even be in your monitored network at all. Depending on your deployment, level of compliance, and other factors, endpoints in your organization where FireAMP Connectors are installed may not be the same hosts as those monitored by your managed devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1671412]Malware Events B[bookmark: marker-1694149]ased on Network Traffic
 
    [bookmark: pgfId-1838515]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-1783232]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1671416]With a Malware license, your managed devices can detect malware in network traffic as part of your overall access control configuration; see Understanding and Creating File Policies. 
 
    [bookmark: pgfId-1989221]The following scenarios can lead to generating malware events:
 
     
     	 [bookmark: pgfId-1671422]If a managed device detects one of a set of specific file types, the Defense Center performs a malware cloud lookup, which returns a file disposition to the Defense Center of  Malware ,  Clean , or  Unknown . 
 
     	 [bookmark: pgfId-1989188]If the Defense Center cannot establish a connection with the cloud, or the cloud is otherwise unavailable, the file disposition is  Unavailable . You may see a small percentage of events with this disposition; this is expected behavior.
 
     	 [bookmark: pgfId-1989191]If the threat score associated with a file exceeds the malware threshold threat score defined in the file policy that detected the file, the Defense Center assigns a file disposition of  Malware to the file. 
 
     	 [bookmark: pgfId-1989195]If the managed device detects a file whose SHA-256 value is stored on the custom detection list, the Defense Center assigns a file disposition of  Custom Detection  to the file. 
 
     	 [bookmark: pgfId-1989198]If the managed device detects a file on the clean list, the Defense Center assigns a file disposition of  Clean to the file. 
 
    
 
    [bookmark: pgfId-1989210]The Defense Center logs records of files’ detection and dispositions, along with other contextual data, as malware events.
 
     
      
    
 
    
 
    [bookmark: pgfId-1671433]Note Files detec[bookmark: marker-1694132]ted in network traffic and identified as malware by the FireSIGHT System generate both a file event and a malware event. This occurs because to detect malware in a file, the system must first detect the file itself. For more information, see Working with File Events and Working with Captured Files.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2142550][bookmark: 48084]Retros[bookmark: marker-2142549]pective Malware Events
 
    [bookmark: pgfId-2142557]Supported Devices: Series 3, virtual
 
    [bookmark: pgfId-2142561]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1671442]For malware files detected in network traffic, file dispositions can change. For example, the Cisco cloud can determine that a file that was previously thought to be clean is now identified as malware, or the reverse — that a malware-identified file is actually clean. 
 
    [bookmark: pgfId-1671449]The cloud notifies the Defense Center if the file disposition changes for a file for which you performed a malware lookup in the last week. Then, two things happen:
 
     
     	 [bookmark: pgfId-1671453]The Defense Center generates a new retrospective malware event. 
 
    
 
    [bookmark: pgfId-1842197]This new retrospective malware event represents a disposition change for all files detected in the last week that have the same SHA-256 hash value. For that reason, these events contain limited information: the date and time the Defense Center was notified of the disposition change, the new disposition, the SHA-256 hash value of the file, and the threat name. They do not contain IP addresses or other contextual information.
 
     
     	 [bookmark: pgfId-1671457]The Defense Center changes the file disposition for previously detected files with the retrospective event’s associated SHA-256 hash value.
 
    
 
    [bookmark: pgfId-1671469]If a file’s disposition changes to Malware, the Defense Center logs a new malware event to its database. Except for the new disposition, the information in this new malware event is identical to that in the file event generated when the file was initially detected.
 
    [bookmark: pgfId-1671473]If a file’s disposition changes to Clean, the Defense Center does not remove the malware event from the malware table. Instead, the event simply reflects the change in disposition. This means that files with clean dispositions can appear in the malware table, but only if they were originally thought to be malware. Files that were never identified as malware appear only in the files table.
 
    [bookmark: pgfId-1671474]In either case, the malware event’s Message indicates how and when the disposition changed, for example:
 
     
     [bookmark: pgfId-1671475]Retrospective Event, Mon Oct 1 20:44:00 2012 (UTC), Old Disp: Unknown, New Disp: Malware 
    
 
    [bookmark: pgfId-1671476]Using Malware Events
 
    [bookmark: pgfId-1842194]You can use the Defense Center’s event viewer to view, search, and delete malware events. Additionally, the Files Dashboard and Context Explorer provide an at-a-glance view of detailed information about the files (including malware files) detected on your network, using charts and graphs. Network file trajectory offers a more in-depth view of individual malware files, providing summary information about the file and how it has moved through the network over time. Using malware detection data, you can trigger correlation rules and create reports, the latter using either the predefined Malware Report template or a custom report template.
 
    [bookmark: pgfId-1602627]For more information, see:
 
     
     	 [bookmark: pgfId-1602631]Viewing Malware Events
 
     	 [bookmark: pgfId-1602635]Understanding the Malware Events Table
 
     	 [bookmark: pgfId-1602639]Searching for Malware Events
 
    
 
     
      [bookmark: pgfId-1836236][bookmark: 41732]Viewing Mal[bookmark: marker-1836233]ware Events
 
     [bookmark: pgfId-1836240]License: Malware or Any
 
     [bookmark: pgfId-2137608]The FireSIGHT System’s event viewer allows you to view malware events in a table, as well as manipulate the event view depending on the information relevant to your analysis. Note that the information available for any individual malware event depends on several factors, including licenses. For more information, see Service Subscriptions. 
 
     [bookmark: pgfId-1602663]The page you see when you access malware events differs depending on the workflow, which is simply a series of pages you can use to evaluate events by moving from a broad to a more focused view. The system is delivered with the following predefined workflows for malware events:
 
      
      	 [bookmark: pgfId-1653030] Malware Summary , the default, provides a list of detected malware, grouped by individual threat.
 
      	 [bookmark: pgfId-1602665] Malware Event Summary provides a quick breakdown of the different malware event types and subtypes.
 
      	 [bookmark: pgfId-1602666] Hosts Receiving Malware and  Hosts Sending Malware provide a list of hosts that have received or sent malware, grouped by the associated malware dispositions for those files. Note that dispositions appear only for files detected as the result of Malware Cloud Lookup or Block Malware file rules.
 
      	 [bookmark: pgfId-1602667] Applications Introducing Malware provides a list of the client applications that accessed or executed the malware detected on endpoints in your organization. From this list, you can drill down into the individual malware files accessed by each parent client.
 
     
 
     [bookmark: pgfId-1602668]You can also create a custom workflow that displays only the information that matches your specific needs. For information on specifying a different default workflow, including a custom workflow, see Configuring Event View Settings.
 
     [bookmark: pgfId-2095184]The FireSIGHT System supports the display and input of Unicode (UTF-8) file names in all areas of the web interface, including the event viewer, event search, dashboard, Context Explorer, and so on. Note, however, that reports you generate in PDF format do not support Unicode; Unicode file names appear in the PDF report in transliterated form. For more information, see Generating and Viewing Reports.
 
     [bookmark: pgfId-1842187]Using the event viewer, you can:
 
      
      	 [bookmark: pgfId-1842188]search for, sort, and constrain events, as well as change the time range for displayed events
 
      	 [bookmark: pgfId-1652585]specify the columns that appear (table view only)
 
      	 [bookmark: pgfId-1652586]view the host profile associated with an IP address, or the user details and host history associated with a user identity
 
      	 [bookmark: pgfId-1652587]view the connections where specific malware was detected (for network-based malware events only)
 
      	 [bookmark: pgfId-1611633]view events using different workflow pages within the same workflow
 
      	 [bookmark: pgfId-1602675]view events using a different workflow altogether
 
      	 [bookmark: pgfId-1602676]drill down page-to-page within a workflow, constraining on specific values
 
      	 [bookmark: pgfId-1842183]bookmark the current page and constraints so you can return to the same data (assuming the data still exists) at a later time
 
      	 [bookmark: pgfId-1842184]view geolocation information for routable IP addresses associated with a file
 
      	 [bookmark: pgfId-1732358]view a file’s trajectory
 
      	 [bookmark: pgfId-2095192]view nested files inside an archive file
 
      	 [bookmark: pgfId-1602678]create a report template using the current constraints
 
      	 [bookmark: pgfId-1602679]delete events from the database
 
      	 [bookmark: pgfId-1894492]add a file to a file list, download a file, submit a file for dynamic analysis, or view the full text of a file’s SHA-256 value
 
      	 [bookmark: pgfId-1894493]view a file’s Dynamic Analysis Summary report, if available
 
      	 [bookmark: pgfId-1894494]use the IP address context menu to whitelist, blacklist, or obtain additional available information about a host or IP address associated with a malware event 
 
     
 
     [bookmark: pgfId-1602681]Note that Series 2 devices, Cisco NGIPS for Blue Coat X-Series, and the DC500 Defense Center do not support network-based malware protection or archive file inspection, which can affect the data displayed. For example, a Series 3 Defense Center managing only Series 2 devices can display only endpoint-based malware events.
 
     [bookmark: pgfId-1835451]For detailed information on using the event viewer, including creating custom workflows, see Understanding and Using Workflows.
 
     [bookmark: pgfId-1602685]To view malware events:
 
     [bookmark: pgfId-1602686]Access: Admin/Any Security Analyst 
 
     
 
     [bookmark: pgfId-1602687]Step 1 Select Analysis > Files > Malware Events.
 
     [bookmark: pgfId-1602688]The first page of your default malware events workflow appears. For information on the columns that appear, see Understanding the Malware Events Table.
 
     [bookmark: pgfId-2078477]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1602693][bookmark: 33113]Understanding the Malw[bookmark: marker-1697900]are Events Table
 
     [bookmark: pgfId-1677289]License: Malware or Any
 
     [bookmark: pgfId-1783696]Supported Devices: feature dependent
 
     [bookmark: pgfId-1783698]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-2047115]The system logs malware events to the Defense Center database when a FireAMP Connector installed on an endpoint in your organization detects a threat, or a managed device detects a file in network traffic that is then identified as malware by a malware cloud lookup. The system also logs retrospective malware events when it learns that a file’s malware disposition has changed. Note that Series 2 devices, Cisco NGIPS for Blue Coat X-Series, and the DC500 Defense Center do not support network-based malware protection, which can affect the data displayed. For example, a Series 3 Defense Center managing only Series 2 devices can display only endpoint-based malware events. For more information, see Understanding Malware Protection and File Control and Working with Malware Events.
 . 
     
 
     [bookmark: pgfId-1842177]Keep in mind that not every field is populated for every event; the different types of malware event can contain different information. For example, because FireAMP malware detection is performed at the endpoint at download or execution time, endpoint-based malware events contain information on file path, invoking client application, and so on. In contrast, because managed devices detect malware files in network traffic, their associated malware events contain port, application protocol, and originating IP address information about the connection used to transmit the file.
 
     [bookmark: pgfId-1691101]The following table lists each malware event field, and indicates whether the system displays information in that field, depending on the malware event type. Note that the DC500 Defense Center does not support sending or receiving continent or country geolocation information.
 
     [bookmark: pgfId-1691430]
 
      
       
        
        [bookmark: pgfId-2049498]Table 40-3 [bookmark: 61763]Malware Event Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-2049508]Field 
          
  
         	 
           
           [bookmark: pgfId-2049510]Description 
          
  
         	 
           
           [bookmark: pgfId-2049512]Network 
          
  
         	 
           
           [bookmark: pgfId-2049514]Endpoint 
          
  
         	 
           
           [bookmark: pgfId-2049516]Retrospective 
           
 from Cloud 
          
  
        
 
         
         	[bookmark: pgfId-2049518]Time
  
         	[bookmark: pgfId-2049520]The date and time the event was generated.
  
         	[bookmark: pgfId-2049522]yes
  
         	[bookmark: pgfId-2049524]yes
  
         	[bookmark: pgfId-2049526]yes
  
        
 
         
         	[bookmark: pgfId-2049528]Action
  
         	[bookmark: pgfId-2049530]The file rule action associated with the rule action for the rule the file matched, and any associated file rule action options.
  
         	[bookmark: pgfId-2049532]yes
  
         	[bookmark: pgfId-2049534]no
  
         	[bookmark: pgfId-2049536]yes
  
        
 
         
         	[bookmark: pgfId-2049538]Sending IP
  
         	[bookmark: pgfId-2049540]The IP address of the host sending detected malware.
  
         	[bookmark: pgfId-2049542]yes
  
         	[bookmark: pgfId-2049544]no
  
         	[bookmark: pgfId-2049546]no
  
        
 
         
         	[bookmark: pgfId-2049548]Sending Continent
  
         	[bookmark: pgfId-2049550]The continent of the host sending detected malware.
  
         	[bookmark: pgfId-2049552]yes
  
         	[bookmark: pgfId-2049554]no
  
         	[bookmark: pgfId-2049556]yes
  
        
 
         
         	[bookmark: pgfId-2049558]Sending Country
  
         	[bookmark: pgfId-2049560]The country of the host sending detected malware.
  
         	[bookmark: pgfId-2049562]yes
  
         	[bookmark: pgfId-2049564]no
  
         	[bookmark: pgfId-2049566]no
  
        
 
         
         	[bookmark: pgfId-2049568]Receiving IP
  
         	[bookmark: pgfId-2049570]For network-based malware events, the IP address of the host receiving detected malware.
 [bookmark: pgfId-2049571]For endpoint-based malware events, the IP address of the endpoint where the FireAMP Connector is installed and where the malware event occurred.
  
         	[bookmark: pgfId-2049576]yes
  
         	[bookmark: pgfId-2049578]yes
  
         	[bookmark: pgfId-2049580]no
  
        
 
         
         	[bookmark: pgfId-2049582]Receiving Continent
  
         	[bookmark: pgfId-2049584]The continent of the host receiving detected malware.
  
         	[bookmark: pgfId-2049586]yes
  
         	[bookmark: pgfId-2049588]no
  
         	[bookmark: pgfId-2049590]yes
  
        
 
         
         	[bookmark: pgfId-2049592]Receiving Country
  
         	[bookmark: pgfId-2049594]The country of the host receiving detected malware.
  
         	[bookmark: pgfId-2049596]yes
  
         	[bookmark: pgfId-2049598]no
  
         	[bookmark: pgfId-2049600]no
  
        
 
         
         	[bookmark: pgfId-2049602]Sending Port
  
         	[bookmark: pgfId-2049604]The source port used by the traffic in which a managed device detected malware.
  
         	[bookmark: pgfId-2049606]yes
  
         	[bookmark: pgfId-2049608]no
  
         	[bookmark: pgfId-2049610]no
  
        
 
         
         	[bookmark: pgfId-2049612]Receiving Port
  
         	[bookmark: pgfId-2049614]The destination port used by the traffic in which a managed device detected malware.
  
         	[bookmark: pgfId-2049616]yes
  
         	[bookmark: pgfId-2049618]no
  
         	[bookmark: pgfId-2049620]no
  
        
 
         
         	[bookmark: pgfId-2049622]SSL Status
  
         	[bookmark: pgfId-2095286]The action associated with the SSL rule, default action, or undecryptable traffic action that logged the encrypted connection:
 
           
           	 [bookmark: pgfId-2095287] Block and  Block with reset represent blocked encrypted connections. 
 
           	 [bookmark: pgfId-2095288] Decrypt (Resign) represents an outgoing connection decrypted using a re-signed server certificate. 
 
           	 [bookmark: pgfId-2095289] Decrypt (Replace Key) represents an outgoing connection decrypted using a self-signed server certificate with a substituted public key.
 
           	 [bookmark: pgfId-2095290] Decrypt (Known Key) represents an incoming connection decrypted using a known private key.
 
           	 [bookmark: pgfId-2095291] Do not Decrypt represents a connection the system did not decrypt.
 
          
 [bookmark: pgfId-2118095]If the system fails to decrypt an encrypted connection, it displays the undecryptable traffic action taken, as well as the failure reason. For example, if the system detects traffic encrypted with an unknown cipher suite and allowed it without further inspection, this field displays Do Not Decrypt (Unknown Cipher Suite).
 ) to view certificate details. For more information, see Viewing the Certificate Associated with an Encrypted Connection.
  
         	[bookmark: pgfId-2049636]yes
  
         	[bookmark: pgfId-2049638]no
  
         	[bookmark: pgfId-2049640]no
  
        
 
         
         	[bookmark: pgfId-2049642]User
  
         	[bookmark: pgfId-2049644]The user of the host (Receiving IP) where the malware event occurred.
 [bookmark: pgfId-2049645]For network-based malware events, this user is determined by network discovery. Because the user is associated with the destination host, users are not associated with malware events where the user uploaded a malware file.
 [bookmark: pgfId-2049649]For endpoint-based malware events, FireAMP Connectors determine user names. FireAMP users cannot be tied to user discovery or control. They do not appear in the Users table, nor can you view details for these users.
  
         	[bookmark: pgfId-2049654]yes
  
         	[bookmark: pgfId-2049656]yes
  
         	[bookmark: pgfId-2049658]no
  
        
 
         
         	[bookmark: pgfId-2049660]Event Type
  
         	[bookmark: pgfId-2049662]The type of malware event. For a full list of event types, see Malware Event Types.
  
         	[bookmark: pgfId-2049667]yes
  
         	[bookmark: pgfId-2049669]yes
  
         	[bookmark: pgfId-2049671]yes
  
        
 
         
         	[bookmark: pgfId-2049673]Event Subtype
  
         	[bookmark: pgfId-2049678]The FireAMP action that led to malware detection, for example, Create, Execute, Move, or Scan.
  
         	[bookmark: pgfId-2049680]no
  
         	[bookmark: pgfId-2049682]yes
  
         	[bookmark: pgfId-2049684]no
  
        
 
         
         	[bookmark: pgfId-2049686]Threat Name
  
         	[bookmark: pgfId-2049688]The name of the detected malware.
  
         	[bookmark: pgfId-2049690]yes
  
         	[bookmark: pgfId-2049692]yes
  
         	[bookmark: pgfId-2049694]yes
  
        
 
         
         	[bookmark: pgfId-2049696]File Name
  
         	[bookmark: pgfId-2049698]The name of the malware file.
  
         	[bookmark: pgfId-2049700]yes
  
         	[bookmark: pgfId-2049702]yes
  
         	[bookmark: pgfId-2049704]no
  
        
 
         
         	[bookmark: pgfId-2049706]File Disposition
  
         	[bookmark: pgfId-2049708]One of the following file dispositions:
 
           
           	 [bookmark: pgfId-2049709] Malware  indicates that the cloud categorized the file as malware, or that the file’s threat score exceeded the malware threshold defined in the file policy.
 
           	 [bookmark: pgfId-2049710] Clean  indicates that the cloud categorized the file as clean, or that a user added the file to the clean list.
 
           	 [bookmark: pgfId-2049711] Unknown  indicates that a malware cloud lookup occurred before the cloud assigned a disposition. The file is uncategorized.
 
           	 [bookmark: pgfId-2049712] Custom Detection indicates that a user added the file to the custom detection list.
 
           	 [bookmark: pgfId-2049715] Unavailable  indicates that the Defense Center could not perform a malware cloud lookup. You may see a small percentage of events with this disposition; this is expected behavior.
 
          
 [bookmark: pgfId-2049717]Note that clean files appear in the malware table only if they were changed to clean; see Retrospective Malware Events.
  
         	[bookmark: pgfId-2049722]yes
  
         	[bookmark: pgfId-2049724]no
  
         	[bookmark: pgfId-2049726]yes
  
        
 
         
         	[bookmark: pgfId-2049728]File SHA256
  
         	[bookmark: pgfId-2049730]The SHA-256 hash value of the file, as well as a network file trajectory icon representing the most recently detected file event and file disposition.
 [bookmark: pgfId-2049731]To view the network file trajectory, click the trajectory icon. For more information, see Analyzing Network File Trajectory.
  
         	[bookmark: pgfId-2049736]yes
  
         	[bookmark: pgfId-2049738]yes
  
         	[bookmark: pgfId-2049740]yes
  
        
 
         
         	[bookmark: pgfId-2049742]Threat Score
  
         	[bookmark: pgfId-2049744]The threat score most recently associated with this file: 
 
           
           	 [bookmark: pgfId-2049748] Low (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2049752] Medium (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2049756] High (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2049760] Very High (
 
           [image: ] ) 
          
 [bookmark: pgfId-2049761]To view the Dynamic Analysis Summary report, click the threat score icon.
  
         	[bookmark: pgfId-2049763]yes
  
         	[bookmark: pgfId-2049765]no
  
         	[bookmark: pgfId-2049767]no
  
        
 
         
         	[bookmark: pgfId-2049769]File Path
  
         	[bookmark: pgfId-2049771]The file path of the malware file, not including the file name.
  
         	[bookmark: pgfId-2049773]no
  
         	[bookmark: pgfId-2049775]yes
  
         	[bookmark: pgfId-2049777]no
  
        
 
         
         	[bookmark: pgfId-2049779]File Type
  
         	[bookmark: pgfId-2049781]The file type of the malware file, for example, HTML or MSEXE.
  
         	[bookmark: pgfId-2049783]yes
  
         	[bookmark: pgfId-2049785]yes
  
         	[bookmark: pgfId-2049787]no
  
        
 
         
         	[bookmark: pgfId-2049789]File Type Category
  
         	[bookmark: pgfId-2049791]The general categories of file type, for example: Office Documents, Archive, Multimedia, Executables, PDF files, Encoded, Graphics, or System Files.
  
         	[bookmark: pgfId-2049793]yes
  
         	[bookmark: pgfId-2049795]yes
  
         	[bookmark: pgfId-2049797]no
  
        
 
         
         	[bookmark: pgfId-2049799]File Timestamp
  
         	[bookmark: pgfId-2049801]The time and date the malware file was created.
  
         	[bookmark: pgfId-2049803]no
  
         	[bookmark: pgfId-2049805]yes
  
         	[bookmark: pgfId-2049807]no
  
        
 
         
         	[bookmark: pgfId-2049809]File Size (KB)
  
         	[bookmark: pgfId-2049811]The size of the malware file, in kilobytes.
  
         	[bookmark: pgfId-2049813]yes
  
         	[bookmark: pgfId-2049815]yes
  
         	[bookmark: pgfId-2049817]no
  
        
 
         
         	[bookmark: pgfId-2049819]File URI
  
         	[bookmark: pgfId-2049821]The originating URI of the malware file, for example, the URL where a user downloaded it.
  
         	[bookmark: pgfId-2049823]yes
  
         	[bookmark: pgfId-2049825]no
  
         	[bookmark: pgfId-2049827]no
  
        
 
         
         	[bookmark: pgfId-2050161]Archive Name
  
         	[bookmark: pgfId-2050163]Name of the archive file (if any) with which the malware file is associated, for example, archive.zip.
  
         	[bookmark: pgfId-2050165]yes
  
         	[bookmark: pgfId-2050167]yes
  
         	[bookmark: pgfId-2050169]no
  
        
 
         
         	[bookmark: pgfId-2050151]Archive SHA256
  
         	[bookmark: pgfId-2050153]The SHA-256 hash value of the archive file (if any) with which the malware file is associated. To view the contents of an archive file, right-click on that archive file’s event viewer row to open the context menu, then click View Archive Contents. For more information, see Viewing the Contents of Archived Files.
  
         	[bookmark: pgfId-2050155]yes
  
         	[bookmark: pgfId-2050157]yes
  
         	[bookmark: pgfId-2050159]no
  
        
 
         
         	[bookmark: pgfId-2050141]Archive Depth
  
         	[bookmark: pgfId-2050143]The level (if any) at which the file was nested in an archive file, for example, 1 or 3.
  
         	[bookmark: pgfId-2050145]yes
  
         	[bookmark: pgfId-2050147]yes
  
         	[bookmark: pgfId-2050149]no
  
        
 
         
         	[bookmark: pgfId-2049829]Application File Name
  
         	[bookmark: pgfId-2049831]The client application accessing the malware file when detection occurred. These applications are not tied to network discovery or application control.
  
         	[bookmark: pgfId-2049833]no
  
         	[bookmark: pgfId-2049835]yes
  
         	[bookmark: pgfId-2049837]no
  
        
 
         
         	[bookmark: pgfId-2049839]Application File SHA256
  
         	[bookmark: pgfId-2049841]The SHA-256 hash value of the parent file accessing the FireAMP-detected or quarantined file when detection occurred.
  
         	[bookmark: pgfId-2049846]no
  
         	[bookmark: pgfId-2049848]yes
  
         	[bookmark: pgfId-2049850]no
  
        
 
         
         	[bookmark: pgfId-2049852]Application Protocol
  
         	[bookmark: pgfId-2049854]The application protocol used by the traffic in which a managed device detected a malware file.
  
         	[bookmark: pgfId-2049856]yes
  
         	[bookmark: pgfId-2049858]no
  
         	[bookmark: pgfId-2049860]no
  
        
 
         
         	[bookmark: pgfId-2049862]Application Protocol, Client, or Web Application Category or Tag
  
         	[bookmark: pgfId-2049864]Criteria that characterize the application to help you understand the application's function; see Table 45-2..
  
         	[bookmark: pgfId-2049869]yes
  
         	[bookmark: pgfId-2049871]no
  
         	[bookmark: pgfId-2049873]yes
  
        
 
         
         	[bookmark: pgfId-2049875]Client
  
         	[bookmark: pgfId-2049877]The client application that runs on one host and relies on a server to send a file.
  
         	[bookmark: pgfId-2049879]yes
  
         	[bookmark: pgfId-2049881]no
  
         	[bookmark: pgfId-2049883]yes
  
        
 
         
         	[bookmark: pgfId-2049885]Web Application
  
         	[bookmark: pgfId-2049887]The application that represents the content or requested URL for HTTP traffic detected in the connection.
  
         	[bookmark: pgfId-2049889]yes
  
         	[bookmark: pgfId-2049891]no
  
         	[bookmark: pgfId-2049893]yes
  
        
 
         
         	[bookmark: pgfId-2049895]IOC
  
         	[bookmark: pgfId-2049897]Whether the malware event triggered an indication of compromise (IOC) against a host involved in the connection. When endpoint-based malware detection triggers an IOC rule, a full malware event is generated, with the type FireAMP IOC. For more information on IOC, see Understanding Indications of Compromise.
  
         	[bookmark: pgfId-2049905]yes
  
         	[bookmark: pgfId-2049907]yes
  
         	[bookmark: pgfId-2049909]yes
  
        
 
         
         	[bookmark: pgfId-2049911]Application Risk
  
         	[bookmark: pgfId-2049913]The risk associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated risk; this field displays the highest of those. For more information, see Table 45-2.
  
         	[bookmark: pgfId-2049918]yes
  
         	[bookmark: pgfId-2049920]no
  
         	[bookmark: pgfId-2049922]yes
  
        
 
         
         	[bookmark: pgfId-2049924]Business Relevance
  
         	[bookmark: pgfId-2049926]The business relevance associated with the application traffic detected in the connection: Very High, High, Medium, Low, or Very Low. Each type of application detected in the connection has an associated business relevance; this field displays the lowest (least relevant) of those. For more information, see Table 45-2.
  
         	[bookmark: pgfId-2049931]yes
  
         	[bookmark: pgfId-2049933]no
  
         	[bookmark: pgfId-2049935]yes
  
        
 
         
         	[bookmark: pgfId-2049937]Detector
  
         	[bookmark: pgfId-2049942]The FireAMP detector that identified the malware, such as ClamAV, Spero, or SHA.
  
         	[bookmark: pgfId-2049944]no
  
         	[bookmark: pgfId-2049946]yes
  
         	[bookmark: pgfId-2049948]no
  
        
 
         
         	[bookmark: pgfId-2049950]Message
  
         	[bookmark: pgfId-2049952]Any additional information associated with the malware event.
 [bookmark: pgfId-2049953]For network-based malware events, this field is populated only for files whose disposition has changed; see Retrospective Malware Events.
  
         	[bookmark: pgfId-2049958]yes
  
         	[bookmark: pgfId-2049960]yes
  
         	[bookmark: pgfId-2049962]no
  
        
 
         
         	[bookmark: pgfId-2049967]FireAMP Cloud
  
         	[bookmark: pgfId-2049969]The name of the FireAMP cloud where the event originated.
  
         	[bookmark: pgfId-2049971]no
  
         	[bookmark: pgfId-2049973]yes
  
         	[bookmark: pgfId-2049975]no
  
        
 
         
         	[bookmark: pgfId-2049977]Device
  
         	[bookmark: pgfId-2049979]For network-based malware events, the name of the device that detected the malware file.
 [bookmark: pgfId-2049980]For endpoint-based malware events and retrospective malware events generated by the cloud, the name of the Defense Center.
  
         	[bookmark: pgfId-2049985]yes
  
         	[bookmark: pgfId-2049987]yes
  
         	[bookmark: pgfId-2049989]yes
  
        
 
         
         	[bookmark: pgfId-2049991]Security Context
  
         	[bookmark: pgfId-2049993]The metadata identifying the virtual firewall group through which the traffic passed. Note that the system only populates this field for ASA FirePOWER devices in multiple context mode.
  
         	[bookmark: pgfId-2049998]yes
  
         	[bookmark: pgfId-2050000]yes
  
         	[bookmark: pgfId-2050002]yes
  
        
 
         
         	[bookmark: pgfId-2050004]Count
  
         	[bookmark: pgfId-2050006]The number of events that match the information in each row. This field appears after you apply a constraint that creates two or more identical rows.
  
         	[bookmark: pgfId-2050008]n/a
  
         	[bookmark: pgfId-2050010]n/a
  
         	[bookmark: pgfId-2050012]n/a
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1602901][bookmark: 22817]Malware Ev[bookmark: marker-1602900]ent Types
 
     [bookmark: pgfId-1783942]License: Malware or Any
 
     [bookmark: pgfId-1784000]Supported Devices: feature dependent
 
     [bookmark: pgfId-1784001]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1783989]For network-based malware events, the event type can be one of:
 
      
      	 [bookmark: pgfId-1620623]Threat Detected in Network File Transfer
 
      	 [bookmark: pgfId-1620684]Threat Detected in Network File Transfer (retrospective)
 
     
 
     [bookmark: pgfId-1602902]An endpoint-based malware event can have any of the following types:
 
      
      	 [bookmark: pgfId-1602903]Blocked Execution
 
      	 [bookmark: pgfId-1602904]Cloud Recall Quarantine
 
      	 [bookmark: pgfId-1602905]Cloud Recall Quarantine Attempt Failed
 
      	 [bookmark: pgfId-1602906]Cloud Recall Quarantine Started
 
      	 [bookmark: pgfId-1602907]Cloud Recall Restore from Quarantine
 
      	 [bookmark: pgfId-1602908]Cloud Recall Restore from Quarantine Failed
 
      	 [bookmark: pgfId-1602909]Cloud Recall Restore from Quarantine Started
 
      	 [bookmark: pgfId-2005171]FireAMP IOC
 
      	 [bookmark: pgfId-1602910]Quarantine Failure
 
      	 [bookmark: pgfId-1602911]Quarantined Item Restored
 
      	 [bookmark: pgfId-1602912]Quarantine Restore Failed
 
      	 [bookmark: pgfId-1602913]Quarantine Restore Started
 
      	 [bookmark: pgfId-1602914]Scan Completed, No Detections
 
      	 [bookmark: pgfId-1602915]Scan Completed With Detections
 
      	 [bookmark: pgfId-1602916]Scan Failed
 
      	 [bookmark: pgfId-1602917]Scan Started
 
      	 [bookmark: pgfId-1602918]Threat Detected
 
      	 [bookmark: pgfId-1602919]Threat Detected in Exclusion
 
      	 [bookmark: pgfId-1602920]Threat Quarantined
 
     
 
     [bookmark: pgfId-1846592]If a file’s trajectory map contains malware events, the events are one of the following types: Threat Detected in Network File Transfer, Threat Detected in Network File Transfer (retrospective), Threat Detected, Threat Detected in Exclusion, and Threat Quarantined. See Working with Network File Trajectory for more information.
 
     [bookmark: pgfId-1836101]Note that Series 2 devices, Cisco NGIPS for Blue Coat X-Series, and the DC500 Defense Center do not support network-based malware protection, which can affect the data displayed. For example, a Series 3 Defense Center managing only Series 2 devices can display only endpoint-based malware events.
 
    
 
     
      [bookmark: pgfId-1602924][bookmark: 47665]Searc[bookmark: marker-1602922]hing for Malware Events
 
     [bookmark: pgfId-1677269]License: Malware or Any
 
     [bookmark: pgfId-1602930]Using the Defense Center’s Search page, you can search for specific malware events, display the results in the event viewer, and save your search criteria to reuse later. Custom Analysis dashboard widgets, report templates, and custom user roles can also use saved searches.
 
     [bookmark: pgfId-1602938]Searches delivered with the system, labeled with (Cisco) in the Saved Searches list, serve as examples.
 
     [bookmark: pgfId-1655356]Keep in mind that your search results depend on the available data in the events you are searching. In other words, depending on the available data, your search constraints may not apply. For example, because endpoint-based malware events are not generated as a result of managed devices inspecting network traffic, they do not contain connection information (port, application protocol, and so on).
 
     [bookmark: pgfId-1602939]General Search Syntax
 
     [bookmark: pgfId-1602940]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-1602941]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-2115545]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-2115546]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-2115547] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-2115548] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-2115549] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-2115550]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-1602943]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-2109904]Specify  n/a in any field to identify events where information is not available for that field; use  !n/a to identify the events where that field is populated.
 
      	 [bookmark: pgfId-2121824]Use the device field to search for specific devices as well as devices in groups, stacks, or clusters. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
      	 [bookmark: pgfId-2109908]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-1602949]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-1602953][bookmark: 13589]Special Search Syntax for Malware Events
 
     [bookmark: pgfId-1655577]To supplement the general search syntax listed above, the following list describes some special search syntax for malware events.
 
     [bookmark: pgfId-2115660]Sending/Receiving IP
 
     [bookmark: pgfId-2115709]The system returns all events where either the Sending IP or the Receiving IP matches the IP address you specify.
 
     [bookmark: pgfId-2115766]Event Type
 
     [bookmark: pgfId-2115811]When searching for events with a specific malware event type (see Malware Event Types), enclose the event type in quotation marks, for example, "Scan Completed With Detection". Otherwise, the system performs a partial match. That is, if you search using the same string but do not use quotation marks, the system returns events with the following types:
 
     [bookmark: pgfId-2115886] – Scan Completed, No Detections
 
     [bookmark: pgfId-2115910] – Scan Completed With Detection
 
     [bookmark: pgfId-2115931]Initiator/Responder Continent
 
     [bookmark: pgfId-2115949]The system returns all events where either the Initiator Continent or the Responder Continent matches the continent you specify.
 
     [bookmark: pgfId-2115970]Initiator/Responder Country
 
     [bookmark: pgfId-2115991]The system returns all events where either the Initiator Country or the Responder Country matches the country you specify.
 
     [bookmark: pgfId-2116048]URI or Message
 
     [bookmark: pgfId-2116069]The system performs a partial match, that is, you can search for all or part of the field contents without using asterisks.
 
     [bookmark: pgfId-2116094]The SSL Actual Action taken
 
     [bookmark: pgfId-2116095]Type any of the following keywords to view malware events for encrypted traffic to which the system applied the action specified:
 
     [bookmark: pgfId-2116096] – Do Not Decrypt represents connections the system did not decrypt.
 
     [bookmark: pgfId-2116097] – Block and Block with Reset represent blocked encrypted connections.
 
     [bookmark: pgfId-2116098] – Decrypt (Known Key) represents incoming connections decrypted using a known private key.
 
     [bookmark: pgfId-2116099] – Decrypt (Replace Key) represents outgoing connections decrypted using a self-signed server certificate with a substituted public key.
 
     [bookmark: pgfId-2116100] – Decrypt (Resign) represents outgoing connections decrypted using a re-signed server certificate.
 
     [bookmark: pgfId-2116101]This column does not appear in the malware events table view.
 
     [bookmark: pgfId-2116259]The SSL Failure Reason
 
     [bookmark: pgfId-2116260]Type any of the following keywords to view malware events for encrypted traffic that the system failed to decrypt for the reason specified: 
 
     [bookmark: pgfId-2116261] – Unknown
 
     [bookmark: pgfId-2116262] – No Match
 
     [bookmark: pgfId-2116263] – Success
 
     [bookmark: pgfId-2116264] – Uncached Session
 
     [bookmark: pgfId-2116265] – Unknown Cipher Suite
 
     [bookmark: pgfId-2116266] – Unsupported Cipher Suite
 
     [bookmark: pgfId-2116267] – Unsupported SSL Version
 
     [bookmark: pgfId-2116268] – SSL Compression Used
 
     [bookmark: pgfId-2116269] – Session Undecryptable in Passive Mode
 
     [bookmark: pgfId-2116270] – Handshake Error
 
     [bookmark: pgfId-2116271] – Decryption Error
 
     [bookmark: pgfId-2116272] – Pending Server Name Category Lookup
 
     [bookmark: pgfId-2116273] – Pending Common Name Category Lookup
 
     [bookmark: pgfId-2116274] – Internal Error
 
     [bookmark: pgfId-2116275] – Network Parameters Unavailable
 
     [bookmark: pgfId-2116276] – Invalid Server Certificate Handle
 
     [bookmark: pgfId-2116277] – Server Certificate Fingerprint Unavailable
 
     [bookmark: pgfId-2116278] – Cannot Cache Subject DN
 
     [bookmark: pgfId-2116279] – Cannot Cache Issuer DN
 
     [bookmark: pgfId-2116280] – Unknown SSL Version
 
     [bookmark: pgfId-2116281] – External Certificate List Unavailable
 
     [bookmark: pgfId-2116282] – External Certificate Fingerprint Unavailable
 
     [bookmark: pgfId-2116283] – Internal Certificate List Invalid
 
     [bookmark: pgfId-2116284] – Internal Certificate List Unavailable
 
     [bookmark: pgfId-2116285] – Internal Certificate Unavailable
 
     [bookmark: pgfId-2116286] – Internal Certificate Fingerprint Unavailable
 
     [bookmark: pgfId-2116287] – Server Certificate Validation Unavailable
 
     [bookmark: pgfId-2116288] – Server Certificate Validation Failure
 
     [bookmark: pgfId-2116289] – Invalid Action
 
     [bookmark: pgfId-2116365]This column does not appear in the malware events table view.
 
     [bookmark: pgfId-2116087]The SSL Subject Country
 
     [bookmark: pgfId-2116439]Type a two-character ISO 3166-1 alpha-2 country code to view malware events for encrypted traffic associated with the country of a certificate subject. 
 
     [bookmark: pgfId-2116440]This column does not appear in the malware events table view.
 
     [bookmark: pgfId-2116456]The SSL Issuer Country
 
     [bookmark: pgfId-2116457]Type a two-character ISO 3166-1 alpha-2 country code to view encrypted traffic associated with the country of a certificate issuer. 
 
     [bookmark: pgfId-2116534]This column does not appear in the malware events table view.
 
     [bookmark: pgfId-2116704]SSL Certificate Fingerprint
 
     [bookmark: pgfId-2116705]Type or paste the SHA hash value used to authenticate a certificate to view traffic associated with that certificate.
 
     [bookmark: pgfId-2117497]This column does not appear in the malware events table view.
 
     [bookmark: pgfId-2116706]SSL Public Key Fingerprint
 
     [bookmark: pgfId-2116707]Type or paste the SHA hash value used to authenticate the public key contained within a certificate to view traffic associated with that certificate.
 
     [bookmark: pgfId-2117528]This column does not appear in the malware events table view.
 
     [bookmark: pgfId-1602960]To search for malware events:
 
     [bookmark: pgfId-1602961]Access: Admin/Any Security Analyst 
 
     
 
     [bookmark: pgfId-2099879]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-2099880]The Search page appears.
 
     [bookmark: pgfId-2099881]Step 2 Select Malware Events from the table drop-down list.
 
     [bookmark: pgfId-2099882]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-2099885]Step 3 Enter your search criteria in the appropriate fields as described in the following sections:
 
      
       
       	 [bookmark: pgfId-2099889]See the  Malware Event Fields  table for information on the fields in the malware events table.
 
       	 [bookmark: pgfId-2108468]See Special Search Syntax for Malware Events for special search syntax for malware events.
 
       	 [bookmark: pgfId-2102798]See Viewing the Certificate Associated with an Encrypted Connection for fields related to public key certificates.
 
      
 
     
 
     [bookmark: pgfId-2099890]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the checkbox clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-2099891]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2099892]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-2099895]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-2100215]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-2099896]Click  Save as New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-2100695]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-2117104]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-2117142]Your search results appear in your default malware events workflow, constrained by the current time range.
 
     [bookmark: pgfId-2077792]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1890458][bookmark: 81526]Working with Captured [bookmark: marker-2014806]Files
 
    [bookmark: pgfId-1890524]License: Malware
 
    [bookmark: pgfId-1978777]Supported Devices: Any except Series 2 or X-Series
 
    [bookmark: pgfId-1978778]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-1894886]The system logs when a managed device captures a file detected in network traffic according to the rules in currently applied file policies. From the event viewer, you can view information associated with the captured file, such as the most recent file name associated with the SHA-256 value, the file disposition and threat score, the file storage status, the archive inspection status, and whether the file was manually submitted for dynamic analysis.
 
     
      
    
 
    
 
    [bookmark: pgfId-1907536]Note Files captured by a device containing malware generate both a file event and a malware event, as malware must be detected before it is captured. For more information, see Working with File Events and Working with Malware Events.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1895299]You can use the Defense Center’s event viewer to view and search captured files, as well as submit captured files for dynamic analysis. Additionally, the Files Dashboard provides an at-a-glance view of detailed information about the files (including malware files) detected on your network, using charts and graphs. 
 
    [bookmark: pgfId-1994741]For more information, see:
 
     
     	 [bookmark: pgfId-1894757]Viewing Captured Files
 
     	 [bookmark: pgfId-1894775]Understanding the Captured Files Table
 
     	 [bookmark: pgfId-1894778]Searching for Captured Files
 
    
 
     
      [bookmark: pgfId-1890514][bookmark: 88498]Viewing Captured Files
 
     [bookmark: pgfId-1891150]License: Malware
 
     [bookmark: pgfId-1893939]The FireSIGHT System’s event viewer allows you to [bookmark: marker-2014811]view captured files in a table, as well as manipulate the event view depending on the information relevant to your analysis.
 
     [bookmark: pgfId-1893940]The page you see when you access captured files differs depending on the workflow, which is simply a series of pages you can use to evaluate events by moving from a broad to a more focused view. The system is delivered with the following predefined workflows for captured files:
 
      
      	 [bookmark: pgfId-1893941] Captured File Summary , the default, provides a breakdown of captured files based on type, category, and threat score.
 
      	 [bookmark: pgfId-1893942] Dynamic Analysis Status provides a count of captured files based on whether they have been submitted for dynamic analysis.
 
     
 
     [bookmark: pgfId-1893738]You can also create a custom workflow that displays only the information that matches your specific needs. For information on specifying a different default workflow, including a custom workflow, see Configuring Event View Settings.
 
     [bookmark: pgfId-2095220]The FireSIGHT System supports the display and input of Unicode (UTF-8) file names in all areas of the web interface, including the event viewer, event search, dashboard, Context Explorer, and so on. Note, however, that reports you generate in PDF format do not support Unicode; Unicode file names appear in the PDF report in transliterated form. For more information, see Generating and Viewing Reports.
 
     [bookmark: pgfId-1893742]Using the event viewer, you can:
 
      
      	 [bookmark: pgfId-1893743]search for, sort, and constrain events, as well as change the time range for displayed events
 
      	 [bookmark: pgfId-1893744]specify the columns that appear (table view only)
 
      	 [bookmark: pgfId-1893745]view events using different workflow pages within the same workflow
 
      	 [bookmark: pgfId-1893746]view events using a different workflow altogether
 
      	 [bookmark: pgfId-1893747]drill down page-to-page within a workflow, constraining on specific values
 
      	 [bookmark: pgfId-1893748]bookmark the current page and constraints so you can return to the same data (assuming the data still exists) at a later time
 
      	 [bookmark: pgfId-1893749]view a file’s trajectory
 
      	 [bookmark: pgfId-2095228]view the contents and inspection status of an archive file
 
      	 [bookmark: pgfId-1893750]add a file to a file list, download a file, submit a file for dynamic analysis, or view the full text of a file’s SHA-256 value
 
      	 [bookmark: pgfId-1893751]view a file’s Dynamic Analysis Summary report, if available
 
      	 [bookmark: pgfId-1894039]submit up to 25 files at a time for dynamic analysis
 
      	 [bookmark: pgfId-2142493]create a report template using the current constraints
 
     
 
     [bookmark: pgfId-2142503]Note that Series 2 devices, Cisco NGIPS for Blue Coat X-Series, and the DC500 Defense Center do not support network-based malware protection or archive file inspection, which can affect the data displayed. For example, a Series 3 Defense Center managing only Series 2 devices cannot display captured files.
 
     [bookmark: pgfId-1893753]For detailed information on using the event viewer, including creating custom workflows, see Understanding and Using Workflows.
 
     [bookmark: pgfId-1893757]To view file events:
 
     [bookmark: pgfId-1893758]Access: Admin/Any Security Analyst 
 
     
 
     [bookmark: pgfId-1893759]Step 1 Select Analysis > Files > Captured Files.
 
     [bookmark: pgfId-1893760]The first page of your default file events workflow appears. For information on the columns that appear, see Understanding the Captured Files Table.
 
     [bookmark: pgfId-2077806]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1890914][bookmark: 50494]Understanding the Captured [bookmark: marker-2014845]Files Table
 
     [bookmark: pgfId-1893682]License: Malware
 
     [bookmark: pgfId-1893630]The Defense Center logs when a managed device captures a file being transmitted in monitored network traffic, according to the settings in an applied file policy.
 . The following table describes the captured file fields. 
     
 
     [bookmark: pgfId-1891370]
 
      
       
        
        [bookmark: pgfId-1891511]Table 40-4 [bookmark: 92928]Captured File Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-1891515]Field 
          
  
         	 
           
           [bookmark: pgfId-1891517]Description 
          
  
        
 
         
         	[bookmark: pgfId-1891519]Last Changed
  
         	[bookmark: pgfId-1891521] The last time the information associated with this file was updated.
  
        
 
         
         	[bookmark: pgfId-1891523]File Name
  
         	[bookmark: pgfId-1891670]The most recently detected file name associated with the file’s SHA-256 hash value.
  
        
 
         
         	[bookmark: pgfId-1908402]Disposition
  
         	[bookmark: pgfId-1980024]One of the following file dispositions:
 
           
           	 [bookmark: pgfId-1980025] Malware  indicates that the cloud categorized the file as malware, or that the file’s threat score exceeded the malware threshold defined in the file policy.
 
           	 [bookmark: pgfId-1980026] Clean  indicates that the cloud categorized the file as clean, or that a user added the file to the clean list.
 
           	 [bookmark: pgfId-1980027] Unknown  indicates that a malware cloud lookup occurred before the cloud assigned a disposition. The file is uncategorized.
 
           	 [bookmark: pgfId-1980028] Custom Detection indicates that a user added the file to the custom detection list.
 
           	 [bookmark: pgfId-1980032] Unavailable  indicates that the Defense Center could not perform a malware cloud lookup. You may see a small percentage of events with this disposition; this is expected behavior.
 
           	 [bookmark: pgfId-1980033] N/A indicates a Detect Files or Block Files rule handled the file and the Defense Center did not perform a malware cloud lookup.
 
          
  
        
 
         
         	[bookmark: pgfId-1891527]SHA256
  
         	[bookmark: pgfId-1891710]The SHA-256 hash value of the file, as well as a network file trajectory icon representing the most recently detected file event and file disposition.
 [bookmark: pgfId-1891529]To view the network file trajectory, click the trajectory icon. For more information, see Analyzing Network File Trajectory.
  
        
 
         
         	[bookmark: pgfId-1891531]Threat Score
  
         	[bookmark: pgfId-1980128]The threat score most recently associated with this file: 
 
           
           	 [bookmark: pgfId-1980132] Low (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-1980136] Medium (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-1980140] High (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-1980144] Very High (
 
           [image: ] ) 
          
 [bookmark: pgfId-1980145]To view the Dynamic Analysis Summary report, click the threat score icon.
  
        
 
         
         	[bookmark: pgfId-1891535]Type
  
         	[bookmark: pgfId-1891537]The type of file, for example, HTML or MSEXE.
  
        
 
         
         	[bookmark: pgfId-1891539]Category
  
         	[bookmark: pgfId-1891541]The general categories of file type, for example: Office Documents, Archive, Multimedia, Executables, PDF files, Encoded, Graphics, or System Files.
  
        
 
         
         	[bookmark: pgfId-1891543]Storage Status
  
         	[bookmark: pgfId-1891545]Whether the file is stored on a managed device.
  
        
 
         
         	[bookmark: pgfId-2050941]Archive Inspection Status
  
         	[bookmark: pgfId-2050943]For archive files, the status of archive inspection:
 
           
           	 [bookmark: pgfId-2051076] Pending  indicates that the system is still inspecting the archive file and its contents. If the file passes through your system again, complete information becomes available.
 
           	 [bookmark: pgfId-2132669] Extracted indicates that the system was able to extract and inspect the archive’s contents.
 
           	 [bookmark: pgfId-2051203] Failed  may, in rare cases, occur if the system is unable to process an extraction.  
 
           	 [bookmark: pgfId-2132714] Depth Exceeded  indicates that the archive contains further nested archive files beyond the maximum allowed depth.
 
           	 [bookmark: pgfId-2051406] Encrypted indicates that the archive file’s contents are encrypted and could not be inspected.
 
           	 [bookmark: pgfId-2051528] Not Inspectable  indicates that the system did not extract and inspect the archive’s contents. Policy rule actions, policy configuration, and corrupted files are three major reasons for this status.
 
          
 [bookmark: pgfId-2051680]To view the contents of an archive file, right-click on its event viewer row to bring up the context menu, then select View Archive Contents. For more information, see Configuring Archive File Inspection Options.
  
        
 
         
         	[bookmark: pgfId-1891547]Analysis Status
  
         	[bookmark: pgfId-1891549]Whether the file was submitted for dynamic analysis.
  
        
 
         
         	[bookmark: pgfId-1893457]Last Sent
  
         	[bookmark: pgfId-1893459]The time the file was most recently submitted to the cloud for dynamic analysis.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1890516][bookmark: 56371]Searching for Captured [bookmark: marker-2014859]Files
 
     [bookmark: pgfId-1891239]License: Malware
 
     [bookmark: pgfId-1892692]Using the Defense Center’s Search page, you can search for specific captured files, display the results in the event viewer, and save your search criteria to reuse later. Custom Analysis dashboard widgets, report templates, and custom user roles can also use saved searches.
 
     [bookmark: pgfId-1892701]Keep in mind that your search results depend on the available data in the events you are searching. In other words, depending on the available data, your search constraints may not apply. For example, if a file has never been submitted for dynamic analysis, it may not have an associated threat score.
 
     [bookmark: pgfId-1892703]General Search Syntax
 
     [bookmark: pgfId-1892704]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-1892705]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-2117170]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-2117171]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-2117172] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-2117173] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-2117174] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-2117175]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-1892707]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-1892708]Specify  n/a in any field to identify events where information is not available for that field; use  !n/a to identify the events where that field is populated.
 
      	 [bookmark: pgfId-1892712]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-1892713]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-1892717]Special Search Syntax for Captured Files
 
      
       
        
        [bookmark: pgfId-1892724]Table 40-5 Captured Files Special Search Syntax 
 
        
        
         
         	 
           
           [bookmark: pgfId-1892728]Search Criterion 
          
  
         	 
           
           [bookmark: pgfId-1892730]Special Syntax 
          
  
        
 
         
         	[bookmark: pgfId-1892732]Storage Status
  
         	[bookmark: pgfId-1892734]Specify one or more of the following:
 
           
           	 [bookmark: pgfId-1982753] File Stored - returns all captured files stored on the device 
 
           	 [bookmark: pgfId-1982807] Unable to Store File - returns all captured files not stored on the device
 
          
  
        
 
         
         	[bookmark: pgfId-1892736]Dynamic Analysis Status
  
         	[bookmark: pgfId-1892743]Specify one or more of the following:
 
           
           	 [bookmark: pgfId-1982976] Sent for Analysis - returns all captured files queued for dynamic analysis
 
           	 [bookmark: pgfId-1982983] Not Sent for Analysis - returns all captured files not submitted for dynamic analysis
 
           	 [bookmark: pgfId-1982990] Analysis Complete - returns all captured files submitted for dynamic analysis that received a threat score and dynamic analysis summary report 
 
           	 [bookmark: pgfId-2015558] Previously Analyzed  - returns all files with a cached threat score that a user tried to submit for dynamic analysis again
 
           	 [bookmark: pgfId-2015905] Failure (Analysis Timeout) - returns all captured files submitted for dynamic analysis for which the cloud has yet to return a result
 
           	 [bookmark: pgfId-2015675] Failure (Network Issue) - returns all files that did not get submitted for dynamic analysis due to a network connectivity failure
 
           	 [bookmark: pgfId-2015682] Failure (Cannot Run File) - returns all files submitted for dynamic analysis that the cloud could not run in the test environment
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1892757]To search for captured files:
 
     [bookmark: pgfId-1892758]Access: Admin/Any Security Analyst 
 
     
 
     [bookmark: pgfId-2100917]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-2100918]The Search page appears.
 
     [bookmark: pgfId-2100919]Step 2 Select Captured Files from the table drop-down list.
 
     [bookmark: pgfId-2100920]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-2100923]Step 3 Enter your search criteria in the appropriate fields.
 
     [bookmark: pgfId-2100927]See the Captured File Fields table for information on the fields in the captured files table.
 
     [bookmark: pgfId-2100928]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-2100929]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2100930]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-2100933]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-2101128]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-2100934]Click  Save as New  to save a new search or assign a name to a search you created by altering a previously-saved search. 
 
      
 
     
 
     [bookmark: pgfId-2101578]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-2117261]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-2117312]Your search results appear in your default captured file workflow, constrained by the current time range.
 
     [bookmark: pgfId-2077539]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1890421][bookmark: 26051]Working with [bookmark: marker-1890420]Network[bookmark: marker-2022309] File Trajectory
 
    [bookmark: pgfId-1807251]License: Malware or Any
 
    [bookmark: pgfId-1807252]Supported Devices: feature dependent
 
    [bookmark: pgfId-1807241]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-1784044]The network file trajectory feature maps how hosts transferred files, including malware files, across your network. You can use the map to determine which hosts may have transferred malware, which hosts are at risk, and observe file transfer trends.
 
    [bookmark: pgfId-1842154]The trajectory map charts file transfer data, the disposition of the file, and if a file transfer was blocked or the file was quarantined. The data used to build the map can come from network-based malware events (any file event for which the system performed a malware cloud lookup and returned a malware disposition) and certain endpoint-based malware events related to detecting and blocking malware (any Threat Detected or Threat Quarantined event type). Vertical lines between data points represent file transfers between hosts. Horizontal lines connecting the data points show a host’s file activity over time. 
 
    [bookmark: pgfId-1842155]You can track the transmission of any file type for which the system can perform a malware cloud lookup. To directly access a file’s trajectory, you can use the Network File Trajectory List page (Analysis > Files > Network File Trajectory) and locate specific files. Additionally, if you are analyzing an intrusion and want to review the trajectory for a related file, you can access the file’s trajectory from the Context Explorer, dashboard, or event views of connection, file, or malware events. 
 
     
      
       
       [bookmark: pgfId-1811739]Table 40-6 License Requirements for Network File Trajectory 
 
       
       
        
        	 
          
          [bookmark: pgfId-1811819]To view... 
         
  
        	 
          
          [bookmark: pgfId-1811821]You need the following license... 
         
  
       
 
        
        	[bookmark: pgfId-1811830]network-based file and malware trajectories
  
        	[bookmark: pgfId-1811835]Malware
  
       
 
        
        	[bookmark: pgfId-1811837]endpoint-based threat and quarantine tracking
  
        	[bookmark: pgfId-1811842]Any (you must have a FireAMP subscription)
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1963963]See Understanding Malware Protection and File Control for more information.
 
    [bookmark: pgfId-1963967]Note that because you cannot use a Malware license with a DC500 nor enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to capture, store or block individual files, submit files for dynamic analysis, view the contents of archive files, or view file trajectories for files for which you conduct a malware cloud lookup. You can, however, still view file trajectories for endpoint-based threat and quarantine tracking.
 
    [bookmark: pgfId-1730655]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1730659]Reviewing Network File Trajectory
 
     	 [bookmark: pgfId-1730663]Analyzing Network File Trajectory
 
    
 
     
      [bookmark: pgfId-1836353][bookmark: 62198]Reviewing Network File Trajectory
 
     [bookmark: pgfId-1836384]License: Malware or Any
 
     [bookmark: pgfId-1836385]Supported Devices: feature dependent
 
     [bookmark: pgfId-1836386]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1836361]As you review captured files, file events, and malware events, you can view a file’s trajectory map from the Context Explorer, properly configured dashboard widgets, and various event views. You can also review the most recently viewed network file trajectories and the most recently detected malware from the Network File Trajectory List page.
 
     [bookmark: pgfId-1809699]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1730669]Viewing the Top File Names Graph
 
      	 [bookmark: pgfId-1809791]Drilling Down on Context Explorer Data
 
      	 [bookmark: pgfId-1730680]Understanding the Custom Analysis Widget
 
      	 [bookmark: pgfId-2095265]Configuring Archive File Inspection Options
 
      	 [bookmark: pgfId-1730688]Understanding the File Events Table
 
      	 [bookmark: pgfId-1809834]Understanding the Malware Events Table
 
      	 [bookmark: pgfId-1925928]Understanding the Captured Files Table
 
      	 [bookmark: pgfId-1809840]Information Available in Connection and Security Intelligence Events
 
      	 [bookmark: pgfId-1809897]Accessing Network File Trajectory
 
     
 
    
 
     
      [bookmark: pgfId-1836335][bookmark: 10991]Accessing Network File Trajectory
 
     [bookmark: pgfId-1836455]License: Malware or Any
 
     [bookmark: pgfId-1836456]Supported Devices: feature dependent
 
     [bookmark: pgfId-1836457]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-2008953]The Network File Trajectory List page allows you to locate files that have a [bookmark: marker-2008954]SHA-256 hash value, whether to analyze the most recently detected malware, or to track a specific threat. 
 
     [bookmark: pgfId-1842136]The page displays the malware most recently detected on your network, as well as the files whose trajectory maps you have most recently viewed. From these lists, you can view when the file was most recently seen on the network, the file’s SHA-256 hash value, name, type, current file disposition, contents (for archive files), and the number of events associated with the file. For more information on the fields, see Understanding the File Events Table.
 
     [bookmark: pgfId-1859331]The page also contains a search box that lets you locate files, either based on SHA-256 hash value or file name, or by the IP address of the host that transferred or received a file. After you locate a file, you can click the File SHA256 value to view the detailed trajectory map. See Analyzing Network File Trajectory for more information.
 
     [bookmark: pgfId-2095278]The FireSIGHT System supports the display and input of Unicode (UTF-8) file names in all areas of the web interface, including the event viewer, event search, dashboard, Context Explorer, and so on. Note, however, that reports you generate in PDF format do not support Unicode; Unicode file names appear in the PDF report in transliterated form. For more information, see Generating and Viewing Reports.
 
     [bookmark: pgfId-1836686]Note that because you cannot use a Malware license with a DC500, nor can you enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to view file trajectories for files for which you conduct a malware cloud lookup.
 
     [bookmark: pgfId-1730750]To locate a file from the Network File Trajectory List page:
 
     [bookmark: pgfId-1730751]Access: Any
 
     
 
     [bookmark: pgfId-1730752]Step 1 Select Analysis > Files > Network File Trajectory.
 
     [bookmark: pgfId-1730753]The Network File Trajectory List page appears, displaying the lists of recently viewed files and recent malware.
 
     [bookmark: pgfId-2008948]Step 2 Optionally, you can type a complete SHA-256 hash value, host IP address, or file name of a file you want to track into the search field and press Enter.
 
     [bookmark: pgfId-2008949]The Query Results page appears listing all files that match the search. If only one result matches, the Network File Trajectory page for that file appears. 
 
     [bookmark: pgfId-2077558]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1839375][bookmark: 91391]Analyzing Network File Trajectory
 
     [bookmark: pgfId-1839382]License: Malware or Any
 
     [bookmark: pgfId-1839383]Supported Devices: feature dependent
 
     [bookmark: pgfId-1836538]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1842129]You can trace a file through the network by viewing the detailed network file trajectory. The file’s trajectory presents summary information about a file, displays the map charting data points over time, and also lists the event data tied to the data points in a table. Using the table and the map, you can pinpoint specific file events, hosts on the network that transferred or received this file, related events in the map, and other related events in a table constrained on selected values.
 
     [bookmark: pgfId-1836716]Note that because you cannot use a Malware license with a DC500, nor can you enable a Malware license on a Series 2 device or Cisco NGIPS for Blue Coat X-Series, you cannot use those appliances to view file trajectories for files for which you conduct a malware cloud lookup.
 
     [bookmark: pgfId-1815015]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1815075]Summary Information
 
      	 [bookmark: pgfId-1815118]Trajectory Map
 
      	 [bookmark: pgfId-1815125]Events Table
 
     
 
    
 
     
      [bookmark: pgfId-1730767][bookmark: 48019]Summary [bookmark: marker-1863723]Information
 
     [bookmark: pgfId-1836564]License: Malware or Any
 
     [bookmark: pgfId-1836565]Supported Devices: feature dependent
 
     [bookmark: pgfId-1836566]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1730769]A file’s trajectory page displays basic information about the file, including file identification information, when the file was first seen and most recently seen on the network, the number of related events and hosts associated with the file, and the file’s current disposition. From this section, if the managed device stored the file, you can download it locally, submit the file for dynamic analysis, or add the file to a file list.
 
      
       
     
 
     
 
     [bookmark: pgfId-1837910]Tip To view related file events, click a field value link. The first page in the File Events default workflow opens in a new window, displaying all file events that also contain the selected value.
 
      
      
 
     
 
     
 
      
      
 
      [bookmark: pgfId-2052651]For more information about archive file inspection, see Configuring Archive File Inspection Options.
 
       
        
        [bookmark: pgfId-1730775]Table 40-7 Network File Trajectory Summary Information Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-1730779]Name 
          
  
         	 
           
           [bookmark: pgfId-1730781]Description 
          
  
        
 
         
         	[bookmark: pgfId-1730783]File SHA256
  
         	[bookmark: pgfId-1730785]The SHA-256 hash value of the file. 
 [bookmark: pgfId-1730786]The hash is displayed by default in a condensed format. To view the full hash value, hover your pointer over it. If multiple SHA-256 hash values are associated with a file name, hover your pointer over the link to view all of the hash values.
 ) to download the file to your local computer. If prompted, confirm you want to download the file. Follow your browser’s prompts to save the file. If the file is unavailable for download, this icon is grayed out.
 
           
            
          
 
          
 
           
           [bookmark: pgfId-1980424]Caution Cisco strongly recommends you do 
           not download malware, as it can cause adverse consequences. Exercise caution when downloading any file, as it may contain malware. Ensure you have taken any necessary precautions to secure the download destination before downloading files. 
            
            
 
           
 
          
  
        
 
         
         	[bookmark: pgfId-1730788]File Names
  
         	[bookmark: pgfId-1730790]The names of the file associated with the event, as seen on the network. 
 [bookmark: pgfId-1730791]If multiple file names are associated with a SHA-256 hash value, the most recent detected file name is listed. You can expand this to view the remaining file names by clicking more. 
  
        
 
         
         	[bookmark: pgfId-1730793]File Type
  
         	[bookmark: pgfId-1730795]The file type of the file, for example, HTML or MSEXE.
  
        
 
         
         	[bookmark: pgfId-1730797]File Category
  
         	[bookmark: pgfId-1730799]The general categories of file type, for example, Office Documents or System Files.
  
        
 
         
         	[bookmark: pgfId-1730801]Parent Application
  
         	[bookmark: pgfId-1730803]The client application accessing the malware file when detection occurred. These applications are not tied to network discovery or application control.
 [bookmark: pgfId-1730804]This field only appears for endpoint-based malware events.
  
        
 
         
         	[bookmark: pgfId-1730806]First Seen
  
         	[bookmark: pgfId-1730808]The first time a managed device or FireAMP Connector detected the file, and the IP address of the host that first uploaded the file.
  
        
 
         
         	[bookmark: pgfId-1730810]Last Seen
  
         	[bookmark: pgfId-1730812]The most recent time a managed device or FireAMP Connector detected the file, and the IP address of the host that last downloaded the file.
  
        
 
         
         	[bookmark: pgfId-1730814]Event Count
  
         	[bookmark: pgfId-1730816]The number of events seen on the network associated with the file, and the number of events displayed in the map if there are more than 250 detected events.
  
        
 
         
         	[bookmark: pgfId-1730818]Seen On
  
         	[bookmark: pgfId-1730820]The number of hosts that either sent or received the file. Because one host can upload and download a file at different times, the total number of hosts may not match the total number of senders plus the total number of receivers in the Seen On Breakdown field.
  
        
 
         
         	[bookmark: pgfId-1838710]Seen On Breakdown
  
         	[bookmark: pgfId-1838712]The number of hosts that sent the file, followed by the number of hosts that received the file. 
  
        
 
         
         	[bookmark: pgfId-1730822]Current Disposition
  
         	[bookmark: pgfId-1980333]One of the following file dispositions:
 
           
           	 [bookmark: pgfId-1980334] Malware  indicates that the cloud categorized the file as malware, or that the file’s threat score exceeded the malware threshold defined in the file policy.
 
           	 [bookmark: pgfId-1980335] Clean  indicates that the cloud categorized the file as clean, or that a user added the file to the clean list.
 
           	 [bookmark: pgfId-1980336] Unknown  indicates that a malware cloud lookup occurred before the cloud assigned a disposition. The file is uncategorized.
 
           	 [bookmark: pgfId-1980337] Custom Detection indicates that a user added the file to the custom detection list.
 
           	 [bookmark: pgfId-1980341] Unavailable  indicates that the Defense Center could not perform a malware cloud lookup. You may see a small percentage of events with this disposition; this is expected behavior.
 
           	 [bookmark: pgfId-1980233] N/A indicates a Detect Files or Block Files rule handled the file and the Defense Center did not perform a malware cloud lookup.
 
          
 ) to add the file to or remove the file from the clean list or custom detection list.
 [bookmark: pgfId-1730825]This field only appears for network-based malware events.
  
        
 
         
         	[bookmark: pgfId-2052381]Archive Contents
  ) to view information about content files in the Archive Contents window. 
        
 
         
         	[bookmark: pgfId-1730827]Threat Name
  
         	[bookmark: pgfId-1730829]Name of the malware threat associated with the file. 
 [bookmark: pgfId-1730830]This field only appears for endpoint-based malware events.
  
        
 
         
         	[bookmark: pgfId-1875220]Threat Score
  
         	[bookmark: pgfId-1895893]The file’s threat score:
 
           
           	 [bookmark: pgfId-2019735] Low (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2019755] Medium (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2019769] High (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-2019780] Very High (
 
           [image: ] ). 
          
 [bookmark: pgfId-1875443]Click the threat score icon to view the Dynamic Analysis Summary report, click the threat score icon.
 [bookmark: pgfId-1875520]Click the threat score link to view all captured files with that threat score.
 ) to submit the file to the cloud for dynamic analysis. If the file is unavailable for submission or you cannot connect to the cloud, this icon is grayed out.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1795384][bookmark: 10158]Trajectory [bookmark: marker-1863728]Map
 
     [bookmark: pgfId-1836588]License: Malware or Any
 
     [bookmark: pgfId-1836589]Supported Devices: feature dependent
 
     [bookmark: pgfId-1836590]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1730837]A file’s trajectory map visually tracks a file from the first detection on your network to the most recent. The map shows when hosts transferred or received the file, how often they transferred the file, and when the file was blocked or quarantined. The map also shows how often file events occurred for the file and when the system assigned the file a disposition or retrospective disposition. You can select a data point in the map and highlight a path that traces back to the first instance the host transferred that file; this path also intersects with every occurrence involving the host as either sender or receiver of the file. The following graphic shows an example trajectory map:
 
      
       [bookmark: pgfId-2153593]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-1842111]The map’s y-axis contains a list of all host IP addresses that have interacted with the file. The IP addresses are listed in descending order based on when the system first detected the file on that host. Each row contains all events associated with that IP address, whether a single file event, file transfer, or retrospective event. The x-axis contains the date and time the system detected each event. The timestamps are listed in chronological order. If multiple events occurred within a minute, all are listed within the same column. You can scroll the map horizontally and vertically to view additional events and IP addresses.
 ). The map then displays the remaining 240 events. The following graphic shows events truncated with the arrow icon: 
      
 
      [bookmark: pgfId-2153606]
 
       
       [image: ] 
      
 ). The first page of the File Events default workflow appears in a new window with all the extra events constrained based on the file type. If endpoint-based malware events are not displayed, you must switch to the Malware Events table to view these. 
      
 
      [bookmark: pgfId-1795659]Each [bookmark: marker-1863712]data point represents an event plus the file disposition, as described in the legend below the map. For example, a Malware Block event icon combines the Malicious Disposition icon and the Block Event icon. 
 
      [bookmark: pgfId-1813857]Endpoint-based malware events include one icon. A retrospective event displays an icon in the column for each host on which the file is detected. File transfer events always include two icons, one file send icon and one file receive icon, connected by a vertical line. Arrows indicate the file transfer direction from sender to receiver. 
 ). The displayed summary information matches the information displayed in the Events table. The following graphic shows an event icon’s summary information: 
      
 
      [bookmark: pgfId-2153619]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-1842096]If you click any event summary information link, the first page of the File Events default workflow appears in a new window with all the extra events constrained based on the file type the File Summary event view opens in a new window, displaying all file events that match on the criteria value you clicked.
 
      [bookmark: pgfId-1842097]To locate the first time a file event occurred involving an IP address, click the address. This highlights a path to that data point, as well as any intervening file events and IP addresses related to the first file event. The corresponding event in the Events table is also highlighted. The map scrolls to that data point if not currently visible. The following graphic shows the path highlighted after clicking an IP address:
 
      [bookmark: pgfId-2153632]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-2008939]To track a file’s progress through the network, you can click any data point to highlight a path that includes all data points related to the selected data point. This includes data points associated with the following types of events:
 
       
       	 [bookmark: pgfId-1737503]any file transfers in which the associated IP address was either sender or receiver
 
       	 [bookmark: pgfId-1737553]any endpoint-based malware events involving the associated IP address
 
       	 [bookmark: pgfId-1737510]if another IP address was involved, all file transfers in which that associated IP address was either sender or receiver
 
       	 [bookmark: pgfId-1737659]if another IP address was involved, any endpoint-based malware events involving the other IP address
 
      
 
      [bookmark: pgfId-2153637]The following graphic shows the path highlighted after clicking an event icon:
 
      [bookmark: pgfId-2153641]
 
       
       [image: ] 
      
 
      [bookmark: pgfId-1842091]All IP addresses and timestamps associated with any highlighted data point are also highlighted. The corresponding event in the Events table is also highlighted. If a path includes truncated events, the path itself is highlighted with a dotted line. Truncated events might intersect the path, but are not displayed in the map. 
 
     
 
    
 
     
      [bookmark: pgfId-1736326][bookmark: 65003]Events [bookmark: marker-1863737]Table
 
     [bookmark: pgfId-1836659]License: Malware or Any
 
     [bookmark: pgfId-1836660]Supported Devices: feature dependent
 
     [bookmark: pgfId-1836661]Supported Defense Centers: feature dependent
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-4488588][bookmark: 66492]Working with[bookmark: marker-4488587] Intrusion Events 
      
      
 
     
 
 
    [bookmark: pgfId-2745008]The FireSIGHT System can help you monitor your network for traffic that could affect the availability, integrity, and confidentiality of a host and its data. By placing managed devices on key network segments, you can examine the packets that traverse your network for malicious activity. The system has several mechanisms it uses to look for the broad range of exploits that attackers have developed.
 
    [bookmark: pgfId-2231594]When the system identifies a possible intrusion, it generates an intrusion event, which is a record of the date, time, the type of exploit, and contextual information about the source of the attack and its target. For packet-based events, a copy of the packet or packets that triggered the event is also recorded. Managed devices transmit their events to the Defense Center where you can view the aggregated data and gain a greater understanding of the attacks against your network assets.
 
    [bookmark: pgfId-1744667]You can also deploy a managed device as an inline, switched, or routed intrusion system, which allows you to configure the device to drop or replace packets that you know to be harmful.
 
    [bookmark: pgfId-1057768]The FireSIGHT System also provides you with the tools you need to review intrusion events and evaluate whether they are important in the context of your network environment and your security policies. These tools include:
 
     
     	 [bookmark: pgfId-4153233]an event summary page that gives you an overview of the current activity on your managed devices
 
     	 [bookmark: pgfId-1057770]text-based and graphical reports that you can generate for any time period you choose; you can also design your own reports and configure them to run at scheduled intervals
 
     	 [bookmark: pgfId-4153249]an incident-handling tool that you can use to gather event data related to an attack; you can also add notes to help you track your investigation and response
 
     	 [bookmark: pgfId-1387089]automated alerting that you can configure for SNMP, email, and syslog
 
     	 [bookmark: pgfId-4153266]automated correlation policies that you can use to respond to and remediate specific intrusion events
 
     	 [bookmark: pgfId-4153267]predefined and custom workflows that you can use to drill down through the data to identify the events that you want to investigate further
 
    
 
    [bookmark: pgfId-1052590]See the following sections for more information:
 
     
     	 [bookmark: pgfId-4153275]Viewing Intrusion Event Statistics describes the Intrusion Event Statistics page, which provides you with an overview of the health of the appliance and a summary of the top threats to your network.
 
     	 [bookmark: pgfId-4230179]Viewing Intrusion Event Performance explains how to generate graphs of intrusion event performance statistics.
 
     	 [bookmark: pgfId-4153279]Viewing Intrusion Event Graphs explains how to generate charts that show event trends over time.
 
     	 [bookmark: pgfId-1751667]Viewing Intrusion Events describes how to use the web interface to view and investigate your intrusion events.
 
     	 [bookmark: pgfId-4153287]Understanding Workflow Pages for Intrusion Events describes the various pages that are available in intrusion event workflows and explains how you can use them to analyze your intrusion events.
 
     	 [bookmark: pgfId-4153291]Using Drill-Down and Table View Pages describes the features of two of the types of pages in an intrusion event workflow.
 
     	 [bookmark: pgfId-3666416]Using the Packet View explains how to use the packet view of intrusion events.
 
     	 [bookmark: pgfId-4392885]Using Impact Levels to Evaluate Events describes how you can use impact levels to evaluate intrusion events.
 
     	 [bookmark: pgfId-4410015]Reading Preprocessor Events explains how you can read events generated by preprocessor rules.
 
     	 [bookmark: pgfId-4392890]Searching for Intrusion Events explains how you can use the search feature to constrain a list of intrusion events to specific criteria.
 
     	 [bookmark: pgfId-4153319]Using the Clipboard describes how to add intrusion events to a holding area called the clipboard so that you can later add the events to incidents. This section also explains how to generate event reports based on the contents of the clipboard.
 
    
 
    [bookmark: pgfId-1745548]Also, see:
 
     
     	 [bookmark: pgfId-4153327]Handling Incidents for more information about incident handling and how you can use incidents to track the progress of an event analysis.
 
     	 [bookmark: pgfId-3371293]Configuring External Alerting for Intrusion Rules for more information about automated alerting.
 
     	 [bookmark: pgfId-3792311]Working with Reports for more information about intrusion event reports.
 
     	 [bookmark: pgfId-4323764]Using Geolocation for more information about geolocation information in intrusion events.
 
    
 
   
 
    
     [bookmark: pgfId-4153335][bookmark: 82198]Viewing Intrusion Ev[bookmark: marker-4153333]ent Statistics
 
    [bookmark: pgfId-4361271]License: Protection
 
    [bookmark: pgfId-4361272]The Intrusion Event Statistics page provides you with a quick summary of the current state of your appliance and any intrusion events generated for your network.
 
    [bookmark: pgfId-4153359]The Intrusion Event Statistics page has three main areas:
 
     
     	 [bookmark: pgfId-4153363]Host Statistics describes the Host Statistics section, which provides information about the appliance and, for Defense Centers, their managed devices.
 
     	 [bookmark: pgfId-4153376]Event Overview describes the Event Overview, which provides an overview of the information in the event database.
 
     	 [bookmark: pgfId-4153380]Event Statistics describes the Event Statistics, which provides more specific details about the information in the event database, such as the top 10 event types.
 
    
 
    [bookmark: pgfId-4225584]Each of the IP addresses, ports, protocols, event messages, and so on on the page is a link. Click any link to view the associated event information. For example, if one of the top 10 destination ports is 80 (http)/tcp, clicking that link displays the first page in the default intrusion events workflow, and lists the events targeting that port. Note that only the events (and the managed devices that generate events) in the current time range appear. Also, intrusion events that you have marked reviewed continue to appear in the statistics. For example, if the current time range is the past hour but the first event was generated five hours ago, when you click the First Event link, the resulting event pages will not show the event until you change the time range.
 
    [bookmark: pgfId-4153392]To view intrusion event statistics:
 
    [bookmark: pgfId-4198140]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-4186459]Step 1 Select Overview > Summary > Intrusion Event Statistics.
 
    [bookmark: pgfId-4186460]The Intrusion Event Statistics page appears.
 
    [bookmark: pgfId-4153399]Step 2 From the two selection boxes at the top of the page, select the zones and devices whose statistics you want to view, or select All Security Zones and All Devices to view statistics for all the devices that are collecting intrusion events.
 
    [bookmark: pgfId-4195988]Step 3 Click Get Statistics.
 
    [bookmark: pgfId-4195989]The Intrusion Event Statistics page refreshes with data from the devices you selected.
 
     
      
    
 
    
 
    [bookmark: pgfId-4185342]Tip To view data from a custom time range, click the link in the upper right page area and follow the directions in Setting Event Time Constraints.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4153419]Step 4 See the following sections for more information about the statistics that appear on the Intrusion Event Statistics page:
 
     
      
      	 [bookmark: pgfId-4153423]Host Statistics
 
      	 [bookmark: pgfId-4153427]Event Overview
 
      	 [bookmark: pgfId-4153431]Event Statistics
 
     
 
    
 
    [bookmark: pgfId-4373409]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-4153434][bookmark: 19384]Host[bookmark: marker-4153433] Statistics
 
     [bookmark: pgfId-4153448]License: Protection
 
     [bookmark: pgfId-4153450]The Host Sta[bookmark: marker-4153449]tistics section of the Intrusion Event Statistics page provides information about the appliance itself. On the Defense Center, this section also provides information about any managed devices.
 
     [bookmark: pgfId-4153464]This information includes the following:
 
      
      	 [bookmark: pgfId-4153465] Time shows the current time on the appliance.
 
      	 [bookmark: pgfId-4153466] Uptime shows the number of days, hours, and minutes since the appliance itself was restarted. On the Defense Center, the uptime also shows the last time each managed device was rebooted, the number of users logged in, and the load average.
 
      	 [bookmark: pgfId-4153470] Disk Usage shows the percentage of the disk that is being used.
 
      	 [bookmark: pgfId-4153471] Memory Usage shows the percentage of system memory that is being used.
 
      	 [bookmark: pgfId-4153472] Load Average shows the average number of processes in the CPU queue for the past 1 minute, 5 minutes, and 15 minutes.
 
     
 
    
 
     
      [bookmark: pgfId-4153474][bookmark: 32040]Event [bookmark: marker-4272439]Overview
 
     [bookmark: pgfId-4153488]License: Protection
 
     [bookmark: pgfId-4153489]The Event Overview section of the Intrusion Event Statistics page provides an overview of the information in the intrusion event database.
 
     [bookmark: pgfId-4153494]These statistics include the following:
 
      
      	 [bookmark: pgfId-4153495] Events shows the number of events in the intrusion event database.
 
      	 [bookmark: pgfId-4153496] Events in Time Range shows the currently selected time range as well as the number and percentage of events from the database that fall within the time range.
 
      	 [bookmark: pgfId-4153497] First Event shows the event message for the first event in the event database.
 
      	 [bookmark: pgfId-4153498] Last Event shows the event message for the last event in the event database.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4153502]Note On the Defense Center, note that if you selected a managed device, the Event Overview section for that device appears instead.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4153505][bookmark: 28720]Event[bookmark: marker-4153504] Statistics
 
     [bookmark: pgfId-4183423]License: Protection
 
     [bookmark: pgfId-4153520]The Event Statistics section of the Intrusion Event Statistics page provides more specific information about of the information in the intrusion event database.
 
     [bookmark: pgfId-4153525]This information includes details on:
 
      
      	 [bookmark: pgfId-4153526]the top 10 event types
 
      	 [bookmark: pgfId-4153527]the top 10 source IP addressees
 
      	 [bookmark: pgfId-4153528]the top 10 destination IP addresses
 
      	 [bookmark: pgfId-4153529]the top 10 destination ports
 
      	 [bookmark: pgfId-4153530]the protocols, ingress and egress security zones, and devices with the greatest number of events
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4229599][bookmark: 76019]Viewing Intrusion Event Performanc[bookmark: marker-4229598]e
 
    [bookmark: pgfId-4229604]License: Protection
 
    [bookmark: pgfId-4229605]The intrusion event performance page allows you to generate graphs that depict performance statistics for intrusion events over a specific period of time. Graphs can be generated to reflect number of intrusion events per second, number of megabits per second, average number of bytes per packet, the percent of packets uninspected by Snort, and the number of packets blocked as the result of TCP normalization. These graphs can show statistics for the last hour, last day, last week, or last month of operation.
 
    [bookmark: pgfId-4342291]See Generating Intrusion Event Performance Statistics Graphs for more information.
 
    [bookmark: pgfId-4229607]To view the intrusion event performance statistics:
 
    [bookmark: pgfId-4229608]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-4229609]Step 1 Select Overview > Summary > Intrusion Event Performance.
 
    [bookmark: pgfId-4229613]The Intrusion Event Performance page appears.
 
    [bookmark: pgfId-4373440]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-4342284][bookmark: 28147][bookmark: 90129]Generating [bookmark: marker-4342283]Intrusion Event Performance Statistics Graphs
 
     [bookmark: pgfId-4229634]License: Protection
 
     [bookmark: pgfId-4229638]You can generate graphs that depict performance statistics for a Defense Center or a managed device based on the number of events per second, megabits per second, average bytes per packet, percent of packets uninspected by Snort, and the number of packets blocked as the result of TCP normalization.
 
      
       
     
 
     
 
     [bookmark: pgfId-4429052]Note New data is accumulated for statistics graphs every five minutes. Therefore, if you reload a graph quickly, the data may not change until the next five-minute increment occurs.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4429053]The following table lists the available graph types. Note that graph types display differently if they are populated with data affected by the network analysis policy Inline Mode setting. If Inline Mode is disabled, the graph types marked with an asterisk (*) in the web interface (a yes in the column below) populate with data about the traffic the system would have modified or dropped if Inline Mode was enabled. For more information about the Inline Mode setting, see Allowing Preprocessors to Affect Traffic in Inline Deployments.
 
     [bookmark: pgfId-4440148]For more information about the required options and settings, see Normalizing Inline Traffic, Allowing Preprocessors to Affect Traffic in Inline Deployments, and Setting Drop Behavior in an Inline Deployment.
 
     [bookmark: pgfId-4417068]
 
      
       
        
        [bookmark: pgfId-4426405]Table 41-1 Intrusion Event Performance Graph Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-4426413]To generate data for... 
          
  
         	 
           
           [bookmark: pgfId-4426415]You must... 
          
  
         	 
           
           [bookmark: pgfId-4427687]Which represents... 
          
  
         	 
           
           [bookmark: pgfId-4426419]Affected by Inline Mode? 
          
  
        
 
         
         	[bookmark: pgfId-4426421]Avg Bytes/Packet
  
         	[bookmark: pgfId-4426423]n/a
  
         	[bookmark: pgfId-4427689]the average number of bytes included in each packet.
  
         	[bookmark: pgfId-4426427]no
  
        
 
         
         	[bookmark: pgfId-4426429]ECN Flags Normalized in TCP Traffic/Packet
  
         	[bookmark: pgfId-4431912]enable Explicit Congestion Notification and select Packet
  
         	[bookmark: pgfId-4427691]the number of packets for which ECN flags have been cleared on a per-packet basis regardless of negotiation.
  
         	[bookmark: pgfId-4426435]yes
  
        
 
         
         	[bookmark: pgfId-4426437]ECN Flags Normalized in TCP Traffic/Session
  
         	[bookmark: pgfId-4431991]enable Explicit Congestion Notification and select Stream
  
         	[bookmark: pgfId-4427693]the number of times that ECN flags have been cleared on a per-stream basis when ECN use was not negotiated.
  
         	[bookmark: pgfId-4426443]yes
  
        
 
         
         	[bookmark: pgfId-4426445]Events/Sec
  
         	[bookmark: pgfId-4432467]n/a
  
         	[bookmark: pgfId-4427695]the number of events per second generated on the device.
  
         	[bookmark: pgfId-4426451]no
  
        
 
         
         	[bookmark: pgfId-4426453]ICMPv4 Echo Normalizations
  
         	[bookmark: pgfId-4426455]enable Normalize ICMPv4
  
         	[bookmark: pgfId-4427697]the number of ICMPv4 packets for which the 8-bit Code field in Echo (Request) or Echo Reply messages were cleared.
  
         	[bookmark: pgfId-4426459]yes
  
        
 
         
         	[bookmark: pgfId-4426461]ICMPv6 Echo Normalizations
  
         	[bookmark: pgfId-4426463]enable Normalize ICMPv6
  
         	[bookmark: pgfId-4427699]the number of ICMPv6 packets for which the 8-bit Code field in Echo (Request) or Echo Reply messages was cleared.
  
         	[bookmark: pgfId-4426467]yes
  
        
 
         
         	[bookmark: pgfId-4426469]IPv4 DF Flag Normalizations
  
         	[bookmark: pgfId-4437519]enable Normalize IPv4 and Normalize Don’t Fragment Bit
  
         	[bookmark: pgfId-4427701]the number of IPv4 packets for which the single-bit Don’t Fragment subfield of the IPv4 Flags header field was cleared.
  
         	[bookmark: pgfId-4426475]yes
  
        
 
         
         	[bookmark: pgfId-4426477]IPv4 Options Normalizations
  
         	[bookmark: pgfId-4426479]enable Normalize IPv4
  
         	[bookmark: pgfId-4427703]the number of IPv4 packets for which the option octet was set to 1 (No Operation).
  
         	[bookmark: pgfId-4426483]yes
  
        
 
         
         	[bookmark: pgfId-4426485]IPv4 Reserved Flag Normalizations
  
         	[bookmark: pgfId-4431329]enable Normalize IPv4 and Normalize Reserved Bit
  
         	[bookmark: pgfId-4427705]the number of IPv4 packets for which the single-bit Reserved subfield of the IPv4 Flags header field was cleared.
  
         	[bookmark: pgfId-4426491]yes
  
        
 
         
         	[bookmark: pgfId-4426493]IPv4 Resize Normalizations
  
         	[bookmark: pgfId-4426495]enable Normalize IPv4
  
         	[bookmark: pgfId-4427707]the number of IPv4 packets with excessive-length payload that have been truncated to the datagram length specified in the IP header. 
  
         	[bookmark: pgfId-4426499]yes
  
        
 
         
         	[bookmark: pgfId-4426501]IPv4 TOS Normalizations
  
         	[bookmark: pgfId-4426503]enable Normalize IPv4 and Normalize TOS Bit
  
         	[bookmark: pgfId-4427709]the number of IPv4 packets for which the one-byte Differentiated Services (DS) field (formerly known as the Type of Service (TOS) field) was cleared.
  
         	[bookmark: pgfId-4426507]yes
  
        
 
         
         	[bookmark: pgfId-4426509]IPv4 TTL Normalizations
  
         	[bookmark: pgfId-4431373]enable Normalize IPv4, Maximum TTL, and Reset TTL
  
         	[bookmark: pgfId-4427711]the number of IPv4 Time to Live normalizations.
  
         	[bookmark: pgfId-4426515]yes
  
        
 
         
         	[bookmark: pgfId-4426517]IPv6 Options Normalizations
  
         	[bookmark: pgfId-4426519]enable Normalize IPv6
  
         	[bookmark: pgfId-4427713]the number of IPv6 packets for which the Option Type field in the Hop-by-Hop Options or Destination Options extension header was set to 00 (Skip and continue processing).
  
         	[bookmark: pgfId-4426523]yes
  
        
 
         
         	[bookmark: pgfId-4426525]IPv6 TTL Normalizations
  
         	[bookmark: pgfId-4426527]enable Normalize IPv6, Minimum TTL, and Reset TTL
  
         	[bookmark: pgfId-4427715]the number of IPv6 Hop Limit (TTL) normalizations.
  
         	[bookmark: pgfId-4426531]yes
  
        
 
         
         	[bookmark: pgfId-4426533]Mbits/Sec
  
         	[bookmark: pgfId-4432481]n/a
  
         	[bookmark: pgfId-4427717]the number of megabits per second of traffic that passes through the device.
  
         	[bookmark: pgfId-4426539]no
  
        
 
         
         	[bookmark: pgfId-4426541]Packet Resized to Fit MSS Normalizations
  
         	[bookmark: pgfId-4426543]enable Trim Data to MSS
  
         	[bookmark: pgfId-4427719]the number of packets for which the payload was longer than the TCP Data field, so the payload was trimmed to the Maximum Segment Size.
  
         	[bookmark: pgfId-4426547]yes
  
        
 
         
         	[bookmark: pgfId-4426549]Packet Resized to Fit TCP Window Normalizations
  
         	[bookmark: pgfId-4426551]enable Trim Data to Window
  
         	[bookmark: pgfId-4427721]the number of packets for which the TCP Data field was trimmed to fit the receiving host’s TCP window.
  
         	[bookmark: pgfId-4426555]yes
  
        
 
         
         	[bookmark: pgfId-4426557]Percent Packets Dropped
  
         	[bookmark: pgfId-4432495]n/a
  
         	[bookmark: pgfId-4427723]the average percentage of uninspected packets across all selected devices. For example, if you select two devices, then an average of 50% may indicate that one device has a 90% drop rate and the other has a 10% drop rate. It may also indicate that both devices have a drop rate of 50%. The graph only represents the total % drop when you select a single device. 
  
         	[bookmark: pgfId-4426563]no
  
        
 
         
         	[bookmark: pgfId-4426565]RST Packets With Data Stripped Normalizations
  
         	[bookmark: pgfId-4426567]enable Remove Data on RST
  
         	[bookmark: pgfId-4427725]the number of packets for which data was removed from a TCP reset (RST) packet.
  
         	[bookmark: pgfId-4426571]yes
  
        
 
         
         	[bookmark: pgfId-4426573]SYN Packets With Data Stripped Normalizations
  
         	[bookmark: pgfId-4426575]enable Remove Data on SYN
  
         	[bookmark: pgfId-4427727]the number of packets for which data was removed from SYN packets when the TCP operating system was not Mac OS.
  
         	[bookmark: pgfId-4426579]yes
  
        
 
         
         	[bookmark: pgfId-4426581]TCP Header Padding Normalizations
  
         	[bookmark: pgfId-4426583]enable Normalize/Clear Option Padding Bytes
  
         	[bookmark: pgfId-4427729]the number of TCP packets in which option padding bytes were set to 0.
  
         	[bookmark: pgfId-4426587]yes
  
        
 
         
         	[bookmark: pgfId-4426589]TCP No Option Normalizations
  
         	[bookmark: pgfId-4432116]enable Allow These TCP Options and set to an option other than any
  
         	[bookmark: pgfId-4427731]the number of packets from which the Time Stamp option was stripped.
  
         	[bookmark: pgfId-4426595]yes
  
        
 
         
         	[bookmark: pgfId-4426597]TCP NS Flag Normalizations
  
         	[bookmark: pgfId-4426599]enable Explicit Congestion Notification and select Packet 
  
         	[bookmark: pgfId-4427733]the number of ECN Nonce Sum (NS) option normalizations.
  
         	[bookmark: pgfId-4426603]yes
  
        
 
         
         	[bookmark: pgfId-4426605]TCP Options Normalizations
  
         	[bookmark: pgfId-4431569]enable Allow These TCP Options and set to an option other than any
  
         	[bookmark: pgfId-4427735]the number of options (excluding MSS, Window Scale, Time Stamp, and explicitly allowed options) for which the option field is set to No Operation (TCP Option 1).
  
         	[bookmark: pgfId-4426611]yes
  
        
 
         
         	[bookmark: pgfId-4426613]TCP Packets Blocked By Normalizations
  
         	[bookmark: pgfId-4432230]enable Normalize TCP Payload (segment reassembly must fail)
  
         	[bookmark: pgfId-4427737]the number of packets dropped because the TCP segments could not be properly reassembled.
  
         	[bookmark: pgfId-4426619]yes
  
        
 
         
         	[bookmark: pgfId-4426621]TCP Reserved Flags Normalizations
  
         	[bookmark: pgfId-4426623]enable Normalize/Clear Reserved Bits
  
         	[bookmark: pgfId-4427739]the number of TCP packets where the Reserved bits have been cleared.
  
         	[bookmark: pgfId-4426627]yes
  
        
 
         
         	[bookmark: pgfId-4426629]TCP Segment Reassembly Normalizations
  
         	[bookmark: pgfId-4426631]enable Normalize TCP Payload (segment reassembly must be successful)
  
         	[bookmark: pgfId-4427741]the number of packets for which the TCP Data field was normalized to ensure consistency in retransmitted data (any segments that cannot be properly reassembled are dropped).
  
         	[bookmark: pgfId-4426635]yes
  
        
 
         
         	[bookmark: pgfId-4426637]TCP SYN Option Normalizations
  
         	[bookmark: pgfId-4426639]enable Allow These TCP Options and set to an option other than any
  
         	[bookmark: pgfId-4427743]the number of options for which the Maximum Segment Size or Window Scale option was set to No Operation (TCP Option 1) because the SYN control bit was not set.
  
         	[bookmark: pgfId-4426643]yes
  
        
 
         
         	[bookmark: pgfId-4426645]TCP Timestamp ECR Normalizations
  
         	[bookmark: pgfId-4432102]enable Allow These TCP Options and set to an option other than any
  
         	[bookmark: pgfId-4427745]the number of packets for which the Time Stamp Echo Reply (TSecr) option field was cleared because the Acknowledgment (ACK) control bit was not set.
  
         	[bookmark: pgfId-4426651]yes
  
        
 
         
         	[bookmark: pgfId-4426653]TCP Urgent Pointer Normalizations
  
         	[bookmark: pgfId-4426655]enable Normalize Urgent Pointer
  
         	[bookmark: pgfId-4427747]the number of packets for which the two-byte TCP header Urgent Pointer field was greater than the payload length and was set to the payload length.
  
         	[bookmark: pgfId-4426659]yes
  
        
 
         
         	[bookmark: pgfId-4426661]Total Blocked Packets
  
         	[bookmark: pgfId-4428391]configure Inline Mode or Drop when Inline
  
         	[bookmark: pgfId-4427749]the total number of dropped packets, including rule, decoder, and preprocessor drops.
  
         	[bookmark: pgfId-4426670]no
  
        
 
         
         	[bookmark: pgfId-4426672]Total Injected Packets
  
         	[bookmark: pgfId-4426674]configure Inline Mode
  
         	[bookmark: pgfId-4427754]the number of packets that were resized before being retransmitted.
  
         	[bookmark: pgfId-4426684]no
  
        
 
         
         	[bookmark: pgfId-4426686]Total TCP Filtered Packets
  
         	[bookmark: pgfId-4426688]configure TCP Stream Preprocessing
  
         	[bookmark: pgfId-4427762]the number of packets skipped by the stream because of TCP port filtering.
  
         	[bookmark: pgfId-4426692]no
  
        
 
         
         	[bookmark: pgfId-4426694]Total UDP Filtered Packets
  
         	[bookmark: pgfId-4426696]configure UDP Stream Preprocessing
  
         	[bookmark: pgfId-4427764]the number of packets skipped by the stream because of UDP port filtering.
  
         	[bookmark: pgfId-4426700]no
  
        
 
         
         	[bookmark: pgfId-4426702]Urgent Flag Cleared Normalizations
  
         	[bookmark: pgfId-4426704]enable Clear URG if Urgent Pointer is Not Set
  
         	[bookmark: pgfId-4427766]the number of packets for which the TCP header URG control bit was cleared because the urgent pointer was not set.
  
         	[bookmark: pgfId-4426708]yes
  
        
 
         
         	[bookmark: pgfId-4426710]Urgent Pointer and Urgent Flag Cleared Normalizations
  
         	[bookmark: pgfId-4426712]enable Clear Urgent Pointer/URG on Empty Payload
  
         	[bookmark: pgfId-4427768]the number of packets for which the TCP header Urgent Pointer field and the URG control bit have been cleared because there was no payload.
  
         	[bookmark: pgfId-4426716]yes
  
        
 
         
         	[bookmark: pgfId-4426718]Urgent Pointer Cleared Normalizations
  
         	[bookmark: pgfId-4426720]enable Clear Urgent Pointer if URG=0
  
         	[bookmark: pgfId-4427770]the number of packets for which the 16-bit TCP header Urgent Pointer field was cleared because the urgent (URG) control bit was not set.
  
         	[bookmark: pgfId-4426724]yes
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4416988]To generate intrusion event performance graphs:
 
     [bookmark: pgfId-4229682]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-4229683]Step 1 Select Overview > Summary > Intrusion Event Performance.
 
     [bookmark: pgfId-4229687]The Intrusion Event Performance page appears.
 
     [bookmark: pgfId-4229692]Step 2 From the Select Device list, select the devices whose data you want to view.
 
     [bookmark: pgfId-4229693]Step 3 From the Select Graph(s) list, select the type of graph you want to create. 
 
     [bookmark: pgfId-4229694]Step 4 From the Select Time Range list, select the time range you would like to use for the graph. 
 
     [bookmark: pgfId-4229695]You can choose from last hour, last day, last week, or last month.
 
     [bookmark: pgfId-4229696]Step 5 Click Graph. 
 
     [bookmark: pgfId-4281838]The graph appears, displaying the information you specified.
 
     [bookmark: pgfId-4281844]Step 6 To save the graph, right-click it and follow the instructions for your browser to save the image.
 
     [bookmark: pgfId-4373455]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4153534][bookmark: 53400]Viewing Intrusion Ev[bookmark: marker-4153532]ent Graphs
 
    [bookmark: pgfId-4183458]License: Protection
 
    [bookmark: pgfId-4153553]The FireSIGHT System provides graphs that show you intrusion event trends over time. You can generate intrusion event graphs over time ranging from the last hour to the last month, for the following:
 
     
     	 [bookmark: pgfId-4153554]one or all managed devices
 
     	 [bookmark: pgfId-4153555]top 10 destination ports
 
     	 [bookmark: pgfId-4153556]top 10 source IP addresses
 
     	 [bookmark: pgfId-4153557]top 10 event messages
 
    
 
    [bookmark: pgfId-4153562]To generate an event graph:
 
    [bookmark: pgfId-4198166]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-4186449]Step 1 Select Overview > Summary > Intrusion Event Graphs.
 
    [bookmark: pgfId-4186450]The Intrusion Event Graphs page appears. Three selection boxes at the top of the page control which graph is generated.
 
    [bookmark: pgfId-4153576]Step 2 Under Select Device, select all to include all devices, or select the specific device you want to include in the graph.
 
    [bookmark: pgfId-4153587]Step 3 Under Select Graph(s), select the type of graph you want to generate.
 
    [bookmark: pgfId-4153588]Step 4 Under Select Time Range, select the time range for the graph.
 
    [bookmark: pgfId-4153589]Step 5 Click Graph.
 
    [bookmark: pgfId-4153590]The graph is generated.
 
    [bookmark: pgfId-4373476]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2489333][bookmark: 15143]Viewing Intrusion[bookmark: marker-2556576] Events
 
    [bookmark: pgfId-4183488]License: Protection
 
    [bookmark: pgfId-4488129]When the system recognizes a packet that is potentially malicious, it generates an intrusion event and adds the event to the database. 
 
    [bookmark: pgfId-4184050]The initial intrusion events view differs depending on the workflow you use to access the page. You can use one of the predefined workflows, which includes one or more drill-down pages, a table view of intrusion events, and a terminating packet view, or you can create your own workflow. You can also view workflows based on custom tables, which may include intrusion events. Note that an event view may be slow to display if it contains a large number of IP addresses and you have enabled the Resolve IP Addresses event view setting. See Configuring Event View Settings for more information.
 
    [bookmark: pgfId-4153643]You view an intrusion event to determine whether there is a threat to your network security. If you are confident that an intrusion event is not malicious, you can mark the event reviewed. Your name appears as the reviewer, and the reviewed event is no longer listed in the default intrusion events view. You can return a reviewed event to the default intrusion events view by marking the event unreviewed.
 
    [bookmark: pgfId-4153644]You can view intrusion events that you have marked reviewed. Reviewed events are stored in the event database and are included in the event summary statistics, but no longer appear in the default event pages. See Reviewing Intrusion Events for more information.
 
    [bookmark: pgfId-4292542]If you perform a backup and then delete reviewed intrusion events, restoring your backup restores the deleted intrusion events but does not restore their reviewed status. You view those restored intrusion events under Intrusion Events, not under Reviewed Events.
 
    [bookmark: pgfId-4292847]To quickly view c[bookmark: marker-4306766]onnection events associated with one or more intrusion events, select the intrusion events using the check boxes in the event viewer, then select Connections from the Jump to drop-down list. This is most useful when navigating between table views of events. You can also view the intrusions associated with particular connections in a similar way.
 
    [bookmark: pgfId-4292543]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-4292547]Understanding Intrusion Events
 
     	 [bookmark: pgfId-4153660]Creating Custom Workflows 
 
     	 [bookmark: pgfId-4294314]Using Drill-Down and Table View Pages 
 
     	 [bookmark: pgfId-4294318]Using the Packet View
 
     	 [bookmark: pgfId-4294338]Viewing Connection Data Associated with Intrusion Events
 
     	 [bookmark: pgfId-4294322]Reviewing Intrusion Events
 
     	 [bookmark: pgfId-4153680]Viewing a Workflow Based on a Custom Table
 
    
 
    [bookmark: pgfId-2489357]To view intrusion events:
 
    [bookmark: pgfId-4198183]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-4186699]Step 1 Select Analysis > Intrusions > Events.
 
    [bookmark: pgfId-4196301]The first page of the default intrusion events workflow appears. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
     
      
    
 
    
 
    [bookmark: pgfId-4153708]Tip If you are using a custom workflow that does not include the table view of intrusion events, select any of the predefined workflows that ship with the appliance by clicking (switch workflow) next to the workflow title.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3583002]See Understanding Intrusion Events to learn more about the events that appear in intrusion event views. See Understanding Workflow Pages for Intrusion Events to learn more about how to narrow your view to the intrusion events that are important to your analysis.
 
    [bookmark: pgfId-4373520]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3583008]Understanding [bookmark: 49674]Intrusion[bookmark: marker-3583007] Even[bookmark: marker-3613009]ts
 
     [bookmark: pgfId-4183505]License: Protection
 
     [bookmark: pgfId-4355449]The system examines the packets that traverse your network for malicious activity that could affect the availability, integrity, and confidentiality of a host and its data. When the system identifies a possible intrusion, it generates an intrusion event, which is a record of the date, time, the type of exploit, and contextual information about the source of the attack and its target. For packet-based events, a copy of the packet or packets that triggered the event is also recorded. Note that the information available for any individual intrusion event depends on several factors, including licenses. For more information, see Service Subscriptions. 
 . 
     
 
     [bookmark: pgfId-3613035]Time
 
     [bookmark: pgfId-3613037]The date and time of the event.
 
     [bookmark: pgfId-3613039]Priority
 
     [bookmark: pgfId-3613041]The event priority as determined by the Cisco VRT.
 
     [bookmark: pgfId-4153739]Impact
 
     [bookmark: pgfId-4153749]The impact level in this field indicates the correlation between intrusion data, network discovery data, and vulnerability information. For more information, see Using Impact Levels to Evaluate Events.
 
     [bookmark: pgfId-4153769]Note that because there is no operating system information available for hosts added to the network map based on NetFlow data, the Defense Center cannot assign Vulnerable (impact level 1: red) impact levels for intrusion events involving those hosts, unless you use the host input feature to manually set the host operating system identity.
 
     [bookmark: pgfId-3620181]Inline Result
 
     [bookmark: pgfId-3623242]One of the following:
 
      
       
       	 [bookmark: pgfId-3630568]a black down arrow, indicating that the system dropped the packet that triggered the rule
 
       	 [bookmark: pgfId-3630578]a gray down arrow, indicating that IPS would have dropped the packet if you enabled the  Drop when Inline intrusion policy option (in an inline deployment), or if a Drop and Generate rule generated the event while the system was pruning
 
       	 [bookmark: pgfId-3630585]blank, indicating that the triggered rule was not set to Drop and Generate Events
 
      
 
     
 
     [bookmark: pgfId-4451462]Note that the system does not drop packets in a passive deployment, including when an inline interface is in tap mode, regardless of the rule state or the inline drop behavior of the intrusion policy.
 
     [bookmark: pgfId-4451475]Source IP
 
     [bookmark: pgfId-4213798]The IP address used by the sending host.
 
     [bookmark: pgfId-4323897]Source Country
 
     [bookmark: pgfId-4323913]The country of the sending host.
 
     [bookmark: pgfId-4213803]Destination IP
 
     [bookmark: pgfId-4213804]The IP address used by the receiving host.
 
     [bookmark: pgfId-4323954]Destination Country
 
     [bookmark: pgfId-4323975]The country of the receiving host.
 
     [bookmark: pgfId-4213809]Original Client IP
 
     [bookmark: pgfId-4381491]The original client IP address that was extracted from an X-Forwarded-For (XFF), True-Client-IP, or custom-defined HTTP header. To display a value for this field, you must enable the HTTP preprocessor Extract Original Client IP Address option in the network analysis policy. Optionally, in the same area of the network analysis policy, you can also specify up to six custom client IP headers, as well as set the priority order in which the system selects the value for the Original Client IP event field. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4381495]This field is enabled by default.
 
     [bookmark: pgfId-4213879]Source Port / ICMP Type
 
     [bookmark: pgfId-4213880]The port number on the sending host. For ICMP traffic, where there is no port number, the system displays the ICMP type.
 
     [bookmark: pgfId-4213881]Destination Port / ICMP Code
 
     [bookmark: pgfId-4213882]The port number for the host receiving the traffic. For ICMP traffic, where there is no port number, the system displays the ICMP code.
 
     [bookmark: pgfId-4410048]SSL Status
 
     [bookmark: pgfId-4410049]The action associated with the SSL rule, default action, or undecryptable traffic action that logged the encrypted connection:
 
     [bookmark: pgfId-4410050] – Block and Block with reset represent blocked encrypted connections. 
 
     [bookmark: pgfId-4410051] – Decrypt (Resign) represents an outgoing connection decrypted using a re-signed server certificate. 
 
     [bookmark: pgfId-4410052] – Decrypt (Replace Key) represents an outgoing connection decrypted using a self-signed server certificate with a substituted public key.
 
     [bookmark: pgfId-4410053] – Decrypt (Known Key) represents an incoming connection decrypted using a known private key.
 
     [bookmark: pgfId-4466668] – Do not Decrypt represents a connection the system did not decrypt.
 
     [bookmark: pgfId-4466669]If the system fails to decrypt an encrypted connection, it displays the undecryptable traffic action taken, as well as the failure reason. For example, if the system detects traffic encrypted with an unknown cipher suite and allowed it without further inspection, this field displays Do Not Decrypt (Unknown Cipher Suite).
 ) to view certificate details. For more information, see 
     Viewing the Certificate Associated with an Encrypted Connection. 
     
 
     [bookmark: pgfId-4356002]VLAN ID
 
     [bookmark: pgfId-4213952]The innermost VLAN ID associated with the packet that triggered the intrusion event.
 
     [bookmark: pgfId-4213966]MPLS Label
 
     [bookmark: pgfId-4245706]The Multiprotocol Label Switching label associated with the packet that triggered this intrusion event.
 
     [bookmark: pgfId-4245812]This field is disabled by default.
 
     [bookmark: pgfId-4245693]Message
 
     [bookmark: pgfId-4213967]The explanatory text for the event. For rule-based intrusion events, the event message is pulled from the rule. For decoder- and preprocessor-based events, the event message is hard coded.
 
     [bookmark: pgfId-4213968]Classification
 
     [bookmark: pgfId-4213971]The classification where the rule that generated the event belongs. See the Rule Classifications table for a list of rule classification names and numbers.
 
     [bookmark: pgfId-4213986]Generator
 
     [bookmark: pgfId-4213989]The component that generated the event. See Table 41-7 for a list of intrusion event generator IDs.
 
     [bookmark: pgfId-4214004]Source User
 
     [bookmark: pgfId-4214005]The User ID for any known user logged in to the source host.
 
     [bookmark: pgfId-4214006]Destination User
 
     [bookmark: pgfId-4214007]The User ID for any known user logged in to the destination host.
 
     [bookmark: pgfId-4213898]Application Protocol
 
     [bookmark: pgfId-4213910]The application protocol, if available, which represents communications between hosts, detected in the traffic that triggered the intrusion event. For information on how the system identifies detected application protocols in the Defense Center web interface, see Table 45-3 .
 
     [bookmark: pgfId-4216357]Client
 
     [bookmark: pgfId-4217017]The client application, if available, which represents software running on the monitored host detected in the traffic that triggered the intrusion event.
 
     [bookmark: pgfId-4217018]Web Application
 
     [bookmark: pgfId-4217021]The web application, which represents the content or requested URL for HTTP traffic detected in the traffic that triggered the intrusion event.
 
     [bookmark: pgfId-4221189]Note that if the system detects an application protocol of HTTP but cannot detect a specific web application, the system supplies a generic web browsing designation here.
 
     [bookmark: pgfId-4339049]IOC
 
     [bookmark: pgfId-4339065]Whether the traffic that triggered the intrusion event also triggered an indication of compromise (IOC) for a host involved in the connection. For more information on IOC, see Understanding Indications of Compromise.
 
     [bookmark: pgfId-4236825]Category, Tag (Application Protocol, Client, Web Application)
 
     [bookmark: pgfId-4236826]Criteria that characterize an application to help you understand the application's function; see Table 45-2.
 
     [bookmark: pgfId-4236800]Application Risk
 
     [bookmark: pgfId-4237580]The risk associated with detected applications in the traffic that triggered the intrusion event. Each type of application detected in a connection has an associated risk; this field displays the highest risk of those. For more information, see Table 45-2.
 
     [bookmark: pgfId-4214046]Business Relevance
 
     [bookmark: pgfId-4237595]The business relevance associated with detected applications in the traffic that triggered the intrusion event. Each type of application detected in a connection has an associated business relevance; this field displays the lowest (least relevant) of those. For more information, see Table 45-2.
 
     [bookmark: pgfId-4214507]Ingress Security Zone
 
     [bookmark: pgfId-4214508]The ingress security zone of the packet that triggered the event. Only this security zone field is populated in a passive deployment. See Working with Security Zones.
 
     [bookmark: pgfId-4214512]Egress Security Zone
 
     [bookmark: pgfId-4214513]For an inline deployment, the egress security zone of the packet that triggered the event. This security zone field is not populated in a passive deployment. See Working with Security Zones.
 
     [bookmark: pgfId-4214517]Device
 
     [bookmark: pgfId-4214518]The managed device where the access control policy was applied. See Managing Devices.
 
     [bookmark: pgfId-4358439]Security Context
 
     [bookmark: pgfId-4358440]The metadata identifying the virtual firewall group through which the traffic passed. Note that the system only populates this field for ASA FirePOWER devices in multiple context mode.
 
     [bookmark: pgfId-4214522]Ingress Interface
 
     [bookmark: pgfId-4214523]The ingress interface of the packet that triggered the event. Only this interface column is populated for a passive interface. See Configuring Sensing Interfaces.
 
     [bookmark: pgfId-4214527]Egress Interface
 
     [bookmark: pgfId-4231879]For an inline set, the egress interface of the packet that triggered the event. This interface column is not populated for a passive interface. See Configuring Sensing Interfaces.
 
     [bookmark: pgfId-4192004]Intrusion Policy
 
     [bookmark: pgfId-4196330]The intrusion policy where the intrusion, preprocessor, or decoder rule that generated the event was enabled. You can select an intrusion policy as the default action for an access control policy, or you can associate an intrusion policy with an access control rule. See Setting Default Handling and Inspection for Network Traffic and Configuring an Access Control Rule to Perform Intrusion Prevention.
 
     [bookmark: pgfId-4192022]Access Control Policy
 
     [bookmark: pgfId-4196793]The access control policy that includes the intrusion policy where the intrusion, preprocessor, or decoder rule that generated the event is enabled; see Managing Access Control Policies.
 
     [bookmark: pgfId-4192036]Access Control Rule
 
     [bookmark: pgfId-4205685]The access control rule that invoked the intrusion policy that generated the event; see Configuring an Access Control Rule to Perform Intrusion Prevention. Default Action indicates that the intrusion policy where the rule is enabled is not associated with a specific access control rule but, instead, is configured as the default action of the access control policy; see Setting Default Handling and Inspection for Network Traffic.
 
     [bookmark: pgfId-4474265]This field is blank if intrusion inspection was associated with neither an access control rule nor the default action, for example, if the packet was examined by the default intrusion policy. For more information, see Setting the Default Intrusion Policy for Access Control.
 
     [bookmark: pgfId-4487248]Network Analysis Policy
 
     [bookmark: pgfId-4487244]The network analysis policy (NAP), if any, associated with the generation of the event; see Getting Started with Network Analysis Policies.
 
     [bookmark: pgfId-4215401]HTTP Hostname
 
     [bookmark: pgfId-4322010]The host name, if present, that was extracted from the HTTP request Host header. Note that request packets do not always include the host name.
 
     [bookmark: pgfId-4322011]To display host names, you must enable the HTTP Inspect preprocessor Log Hostname option. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4215407]This column displays the first fifty characters of the extracted host name. You can hover your pointer over the displayed portion of an abbreviated host name to display the complete name, up to 256 bytes. You can also display the complete host name, up to 256 bytes, in the packet view. See Viewing Event Information for more information.
 
     [bookmark: pgfId-4215411]This field is disabled by default.
 
     [bookmark: pgfId-4215412]HTTP URI
 
     [bookmark: pgfId-4322003]The raw URI, if present, associated with the HTTP request packet that triggered the intrusion event. Note that request packets do not always include a URI.
 
     [bookmark: pgfId-4322004]To display the extracted URI, you must enable the HTTP Inspect preprocessor Log URI option. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4310751]To see the associated HTTP URI in intrusion events triggered by HTTP responses, you should configure HTTP server ports in the Perform Stream Reassembly on Both Ports option; note, however, that this increases resource demands for traffic reassembly. See Selecting Stream Reassembly Options.
 
     [bookmark: pgfId-4215418]This column displays the first fifty characters of the extracted URI. You can hover your pointer over the displayed portion of an abbreviated URI to display the complete URI, up to 2048 bytes. You can also display the complete URI, up to 2048 bytes, in the packet view. See Viewing Event Information for more information.
 
     [bookmark: pgfId-4215422]This field is disabled by default.
 
     [bookmark: pgfId-4215423]Email Sender
 
     [bookmark: pgfId-4215424]The address of the email sender that was extracted from the SMTP MAIL FROM command. To display a value for this field, you must enable the SMTP preprocessor Log From Address option. Multiple sender addresses are supported. See Understanding SMTP Decoding for more information. 
 
     [bookmark: pgfId-4215428]This field is disabled by default.
 
     [bookmark: pgfId-4215429]Email Recipient
 
     [bookmark: pgfId-4215430]The address of the email recipient that was extracted from the SMTP RCPT TO command. To display a value for this field, you must enable the SMTP preprocessor Log To Addresses option. Multiple recipient addresses are supported. See Understanding SMTP Decoding for more information.
 
     [bookmark: pgfId-4215434]This field is disabled by default.
 
     [bookmark: pgfId-4215435]Email Attachments
 
     [bookmark: pgfId-4215436]The MIME attachment file name that was extracted from the MIME Content-Disposition header. To display attachment file names, you must enable the SMTP preprocessor Log MIME Attachment Names option. Multiple attachment file names are supported. See Understanding SMTP Decoding for more information.
 
     [bookmark: pgfId-4215440]This field is disabled by default.
 
     [bookmark: pgfId-4192386]Reviewed By
 
     [bookmark: pgfId-4192387]The name of the user who reviewed the event. See Reviewing Intrusion Events.
 
     [bookmark: pgfId-4153955]Count
 
     [bookmark: pgfId-4288127]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-4289044][bookmark: 10930]Viewing Connection Data Asso[bookmark: marker-4306777]ciated with Intrusion Events
 
     [bookmark: pgfId-4289048]License: Protection
 
     [bookmark: pgfId-4289049]The system can log the connections where intrusion events are detected. Although this logging is automatic for intrusion policies associated with access control rules, you must manually enable connection logging to see associated connection data for the default action; see Logging Connections Based on Access Control Handling.
 
      
       
     
 
     
 
     [bookmark: pgfId-4488601]Note The information available for any individual connection or Security Intelligence event depends on several factors, including licenses and appliance model. For more information, see License and Model Requirements for Connection Logging.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4289068]To view connection data associated with one or more intrusion events:
 
     [bookmark: pgfId-4307073]Access: Admin
 
     
 
     [bookmark: pgfId-4290029]Step 1 Select Analysis > Intrusions > Events.
 
     [bookmark: pgfId-4290544]The first page of the default intrusion events workflow appears.
 
     [bookmark: pgfId-4290834]Viewing associated data is most useful when navigating between table views of events. See Understanding Workflow Pages for Intrusion Events to learn more about how to narrow your view to the intrusion events that are important to your analysis.
 
     [bookmark: pgfId-4291277]Step 2 Select the intrusion events using the check boxes in the event viewer, then select Connections from the Jump to drop-down list.
 
     [bookmark: pgfId-4291278]You can view the intrusion events associated with particular connections in a similar way. For more information, see Navigating Between Workflows.
 
     [bookmark: pgfId-4289075]When you view associated events, the Defense Center uses your default connection data workflow. For more information on connection data, see Working with Connection & Security Intelligence Data.
 
      
       
     
 
     
 
     [bookmark: pgfId-4302006]Tip If you are using a custom workflow that does not include the table view of intrusion events, select any of the predefined workflows that ship with the appliance by clicking (switch workflow) next to the workflow title.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4373650]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4288137][bookmark: 11175]Reviewing [bookmark: marker-4288136]Intrusion Events
 
     [bookmark: pgfId-4183521]License: Protection
 
     [bookmark: pgfId-4153985]If you have examined an intrusion event and are confident that the event does not represent a threat to your network security (perhaps because you know that none of the hosts on your network are vulnerable to the detected exploit), you can mark the event reviewed. Your name appears as the reviewer, and the reviewed event is no longer listed in the default intrusion events view. Events that you mark reviewed remain in the event database, but no longer appear in intrusion event views. 
 
     [bookmark: pgfId-4153986]To mark an intrusion event reviewed:
 
     [bookmark: pgfId-4198204]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4153991]Step 1 On a page that displays intrusion events, you have two options:
 
      
       
       	 [bookmark: pgfId-4153992]To mark one or more intrusion events from the list of events, select the check boxes next to the events and click  Review .
 
       	 [bookmark: pgfId-4153993]To mark all intrusion events from the list of events, click  Review All .
 
      
 
     
 
     [bookmark: pgfId-4153994]A success message appears and the list of reviewed events is updated.
 
     [bookmark: pgfId-4153998]See Understanding Intrusion Events to learn more about the events that appear in intrusion event views. See Understanding Workflow Pages for Intrusion Events to learn more about how to narrow your view to the intrusion events that are important to your analysis.
 
      
       
     
 
     
 
     [bookmark: pgfId-4154002]Note Although they do not appear on intrusion event-related workflow pages, reviewed events are included in the event summary statistics. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4373533]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4154003]To view events previously marked reviewed:
 
     [bookmark: pgfId-4186987]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4282518]Step 1 Select Analysis > Intrusions > Reviewed Events.
 
     [bookmark: pgfId-4282519]The first page of the default reviewed intrusion events workflow appears. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-4282408]Tip If you are using a custom workflow that does not include the table view of intrusion events, select any of the predefined workflows that ship with the appliance by clicking (switch workflow) next to the workflow title.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4282412]See Understanding Intrusion Events to learn more about the events that appear in reviewed intrusion event views. See Understanding Workflow Pages for Intrusion Events to learn more about how to narrow your view to the intrusion events that are important to your analysis.
 
     [bookmark: pgfId-4373549]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4282416]To mark reviewed events unreviewed:
 
     [bookmark: pgfId-4197982]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4154032]Step 1 On a page that displays reviewed events, you have two options:
 
      
       
       	 [bookmark: pgfId-4154033]To remove individual intrusion events from the list of reviewed events, select the check boxes next to the events and click  Unreview .
 
       	 [bookmark: pgfId-4154034]To remove all intrusion events from the list of reviewed events, click  Unreview All .
 
      
 
     
 
     [bookmark: pgfId-4154035]A success message appears and the list of reviewed events is updated.
 
     [bookmark: pgfId-4373565]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4154038][bookmark: 18689]Understanding Workflow Pages for[bookmark: marker-4154037] Intrusion Events
 
    [bookmark: pgfId-4183538]License: Protection
 
    [bookmark: pgfId-4154053]The preprocessor, decoder, and intrusion rules that are enabled in the current intrusion policy generate intrusion events whenever the traffic that you monitor violates the policy.
 
    [bookmark: pgfId-4154057]The FireSIGHT System provides a set of predefined workflows, populated with event data, that you can use to view and analyze intrusion events. Each of these workflows steps you through a series of pages to help you pinpoint the intrusion events that you want to evaluate.
 
    [bookmark: pgfId-4154058]The predefined intrusion event workflows contain three different types of pages, or event views:
 
     
     	 [bookmark: pgfId-4154059]one or more drill-down pages
 
     	 [bookmark: pgfId-4154060]the table view of intrusion events
 
     	 [bookmark: pgfId-4154061]a packet view
 
    
 
    [bookmark: pgfId-4154063]Drill-down pages generally[bookmark: marker-4154062] include two or more columns in a table (and, for some drill-down views, more than one table) that allow you to view one specific type of information.
 
    [bookmark: pgfId-4347575]When you “drill down” to find more information for one or more destination ports, you automatically select those events and the next page in the workflow appears. In this way, drill-down tables help you reduce the number of events you are analyzing at one time. 
 
    [bookmark: pgfId-4204645]The initial table view of[bookmark: marker-4204644] intrusion events lists each intrusion event in its own row. The columns in the table list information such as the time, the source IP address and port, the destination IP address and port, the event priority, the event message, and more.
 
    [bookmark: pgfId-4154080]When you select events on a table view, instead of selecting events and displaying the next page in the workflow, you add to what are called constraints. Constraints are limits that you impose on the types of events that you want to analyze.
 column. 
    
 
    [bookmark: pgfId-4154093]If you select one or more rows in a table view and then click View, the packet view appears. A packet view provides[bookmark: marker-4154094] information about the packet that triggered the rule or the preprocessor that generated the event. Each section of the packet view contains information about a specific layer in the packet. You can expand collapsed sections to see more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-4154106]Note Because each portscan event is triggered by multiple packets, portscan events use a special version of the packet view. See Detecting Portscans for more information.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4154110]If the predefined workflows do not meet your specific needs, you can create custom workflows that display only the information you are interested in. Custom intrusion event workflows can include drill-down pages, a table view of events, or both; the system automatically includes a packet view as the last page. You can easily switch between the predefined workflows and your own custom workflows depending on how you want to investigate events. 
 
     
      
    
 
    
 
    [bookmark: pgfId-4154117]Tip Understanding and Using Workflows explains how to use workflows and the features common to all workflow pages. This chapter also explains how to create and use custom intrusion event workflows.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4154118]For more information, see:
 
     
     	 [bookmark: pgfId-4154122]Using Drill-Down and Table View Pages, which explains how to use drill-down pages and the table view of events, which share many common features.
 
     	 [bookmark: pgfId-4154126]Using the Packet View, which explains how to use the features in the packet view.
 
     	 [bookmark: pgfId-4154130]Searching for Intrusion Events explains how to search the event database for specific intrusion events.
 
    
 
   
 
    
     [bookmark: pgfId-4154135][bookmark: 44795]Using Drill-Down and Ta[bookmark: marker-4154133]ble View Pages
 
    [bookmark: pgfId-4183568]License: Protection
 
    [bookmark: pgfId-4154160]The workflows that you can use to investigate intrusion events take advantage of three different types of pages:
 
     
     	 [bookmark: pgfId-4154161]drill-down pages
 
     	 [bookmark: pgfId-4154162]the table view of intrusion events
 
     	 [bookmark: pgfId-4154163]the packet view
 
    
 
    [bookmark: pgfId-4154166]Each of these pages is described in Understanding Workflow Pages for Intrusion Events.
 
     
     
 
      
       
       [bookmark: pgfId-4154178]Table 41-2 [bookmark: 71771]Intrusion Event Common Features 
 
       
       
        
        	 
          
          [bookmark: pgfId-4154182]To... 
         
  
        	 
          
          [bookmark: pgfId-4154184]You can... 
         
  
       
 
        
        	[bookmark: pgfId-4154186]learn more about the columns that appear
  
        	[bookmark: pgfId-4154191]find more information in Understanding Intrusion Events.
  
       
 
        
        	[bookmark: pgfId-4154193]view a host’s profile
  ) that appears next to the host IP address. 
       
 
        
        	[bookmark: pgfId-4324074]view geolocation details
  
        	[bookmark: pgfId-4324076]click the flag icon that appears in the Source Country or Destination Country columns.
  
       
 
        
        	[bookmark: pgfId-4154203]modify the time and date range for displayed events
  
        	[bookmark: pgfId-4154207]find more information in Setting Event Time Constraints.
 [bookmark: pgfId-4154209]Note that events generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.
  
       
 
        
        	[bookmark: pgfId-4154211]sort and constrain events on the current workflow page
  
        	[bookmark: pgfId-4154213]find more information in:
 
          
          	 [bookmark: pgfId-4154217]Sorting Drill-Down Workflow Pages
 
          	 [bookmark: pgfId-4154221]the  Constraining Events on Drill-Down Pages  table
 
          	 [bookmark: pgfId-4154224]the  Constraining Events on the Table View of Events  table
 
         
  
       
 
        
        	[bookmark: pgfId-4154227]navigate within the current workflow page
  
        	[bookmark: pgfId-4154231]find more information in Navigating to Other Pages in the Workflow.
 [bookmark: pgfId-4154233]Tip To avoid displaying the same intrusion events on different workflow pages, the time range pauses when you click a link at the bottom of the page to display another page of events, and resumes when you click to take any other action on the subsequent page. For more information, see Setting Event Time Constraints.  
       
 
        
        	[bookmark: pgfId-4154238]navigate between pages in the current workflow, keeping the current constraints
  
        	[bookmark: pgfId-4154240]click the appropriate page link at the top left of the workflow page. For more information, see Using Workflow Pages.
  
       
 
        
        	[bookmark: pgfId-4154246]add[bookmark: marker-4154245] events to the clipboard so you can transfer them to an incident at a later time
  
        	[bookmark: pgfId-4154248]use one of the following methods:
 
          
          	 [bookmark: pgfId-4154249]To copy several intrusion events on a workflow page to the clipboard, select the check boxes next to events you want to copy, then click  Copy .
 
          	 [bookmark: pgfId-4154250]To copy all the intrusion events in the current constrained view to the clipboard, click  Copy All .
 
         
 [bookmark: pgfId-4154251]The clipboard stores up to 25,000 events per user. For more information, see Using the Clipboard.
  
       
 
        
        	[bookmark: pgfId-4154257]del[bookmark: marker-4154256]ete events from the event database
  
        	[bookmark: pgfId-4154259]use one of the following methods:
 
          
          	 [bookmark: pgfId-4154260]To delete selected intrusion events, select the check boxes next to events you want to delete, then click  Delete .
 
          	 [bookmark: pgfId-4154261]To delete all the intrusion events in the current constrained view, click  Delete All , then confirm you want to delete all the events.
 
         
  
       
 
        
        	[bookmark: pgfId-4154273]mark events reviewed to remove them from intrusion event pages, but not the event database
  
        	[bookmark: pgfId-4154275]use one of the following methods:
 
          
          	 [bookmark: pgfId-4154276]To review selected intrusion events, select the check boxes next to events you want to review, then click  Review .
 
          	 [bookmark: pgfId-4154277]To review all the intrusion events in the current constrained view, click  Review All .
 
         
 [bookmark: pgfId-4154281]For more information, see Reviewing Intrusion Events.
  
       
 
        
        	[bookmark: pgfId-4154283]download a local copy of the packet (a packet capture file in libpcap format) that triggered each selected event
  
        	[bookmark: pgfId-4154285]use one of the following methods:
 
          
          	 [bookmark: pgfId-4154286]To download the packets that triggered the selected intrusion events, select the check boxes next to events triggered by the packets you want to download, then click  Download Packets .
 
          	 [bookmark: pgfId-4154287]To download all packets that triggered the intrusion events in the current constrained view, click  Download All Packets .
 
         
 [bookmark: pgfId-4154288]Captured packets are saved in libpcap format. This format is used by several popular protocol analyzers.
  
       
 
        
        	[bookmark: pgfId-4154290]navigate to other event views to view associated events
  
        	[bookmark: pgfId-4154294]find more information in Navigating Between Workflows.
  
       
 
        
        	[bookmark: pgfId-4154300]temporarily use a different workflow
  
        	[bookmark: pgfId-4154304]click (switch workflow). For more information, see Selecting Workflows.
  
       
 
        
        	[bookmark: pgfId-4154307]bookmark the current page so that you can quickly return to it
  
        	[bookmark: pgfId-4154311]click Bookmark This Page. For more information, see Using Bookmarks.
  
       
 
        
        	[bookmark: pgfId-4287787]view the Intrusion Events section of the Summary Dashboard
  
        	[bookmark: pgfId-4287789]click Dashboards. For more information, see Working with Dashboards.
  
       
 
        
        	[bookmark: pgfId-4154314]navigate to the bookmark management page
  
        	[bookmark: pgfId-4154318]click View Bookmarks. For more information, see Using Bookmarks.
  
       
 
        
        	[bookmark: pgfId-4154321]generate a report based on the data in the current view
  
        	[bookmark: pgfId-4154325]click Report Designer. For more information, see Creating a Report Template from an Event View.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3659328]The number of intrusion events that appear on the event views may be quite large, depending on:
 
     
     	 [bookmark: pgfId-3659329]the time range you select
 
     	 [bookmark: pgfId-3659330]the amount of traffic on your network
 
     	 [bookmark: pgfId-3659331]the intrusion policy you apply
 
    
 
    [bookmark: pgfId-4154335]To make it easier to analyze intrusion events, you can constrain the event pages. The constraining processes are slightly different for drill-down views and the table view of intrusion events. 
 
     
      
    
 
    
 
    [bookmark: pgfId-4154336]Tip The time range pauses when you click one of the links at the bottom of the intrusion event workflow page to navigate to another page, and resumes when you click to take any other action on the subsequent page, including exiting the workflow; this reduces the likelihood of displaying the same events as you navigate to other pages in the workflow to see more events. For more information, see Setting Event Time Constraints and Navigating to Other Pages in the Workflow.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-4154354]Table 41-3 [bookmark: 83860]Constraining Events on Drill-Down Pages 
 
       
       
        
        	 
          
          [bookmark: pgfId-4154358]To... 
         
  
        	 
          
          [bookmark: pgfId-4154360]You can... 
         
  
       
 
        
        	[bookmark: pgfId-4154362]drill down to the next workflow page constraining on a specific value
  
        	[bookmark: pgfId-4154364]click the value.
 [bookmark: pgfId-4154365]For example, on the Destination Port workflow, to constrain the events to those with a destination of port 80, click 80/tcp in the DST Port/ICMP Code column. The next page of the workflow, Events, appears and contains only port 80/tcp events.
  
       
 
        
        	[bookmark: pgfId-4154367]drill down to the next workflow page constraining on selected events
  
        	[bookmark: pgfId-4154369]select the check boxes next to the events you want to view on the next workflow page, then click View. 
 [bookmark: pgfId-4154370]For example, on the Destination Port workflow, to constrain the events to those with destination ports 20/tcp and 21/tcp, select the check boxes next to the rows for those ports and click View. The next page of the workflow, Events, appears and contains only port 20/tcp and 21/tcp events.
 [bookmark: pgfId-4154371]Note If you constrain on multiple rows and the table has more than one column (not including a Count column), you build what is called a compound constraint. Compound constraints ensure that you do not include more events in your constraint than you mean to. For example, if you use the Event and Destination workflow, each row that you select on the first drill-down page creates a compound constraint. If you pick event 1:100 with a destination IP address of 10.10.10.100 and you also pick event 1:200 with a destination IP address of 192.168.10.100, the compound constraint ensures that you do not also select events with 1:100 as the event type and 192.168.10.100 as the destination IP address or events with 1:200 as the event type and 10.10.10.100 as the destination IP address. 
  
       
 
        
        	[bookmark: pgfId-4154373]drill down to the next workflow page keeping the current constraints
  
        	[bookmark: pgfId-4154375]click View All.
  
       
 
       
     
 
    
 
     
     
 
      
       
       [bookmark: pgfId-4154387]Table 41-4 [bookmark: 93672]Constraining Events on the Table View of Events 
 
       
       
        
        	 
          
          [bookmark: pgfId-4154391]To... 
         
  
        	 
          
          [bookmark: pgfId-4154393]You can... 
         
  
       
 
        
        	[bookmark: pgfId-4154395]constrain the view to events with a single attribute
  
        	[bookmark: pgfId-4154397]click the attribute. 
 [bookmark: pgfId-4154398]For example, to constrain the view to events with a destination of port 80, click 80/tcp in the DST Port/ICMP Code column.
  
       
 
        
        	[bookmark: pgfId-4154400]remove a column from the table
  . . 
       
 
        
        	[bookmark: pgfId-4154411]view the packets associated with one or more events
  
        	[bookmark: pgfId-4188950]either:
 
          
          	 [bookmark: pgfId-4188951]click the down arrow icon (
 
          [image: ] ) next to the event whose packets you want to view. 
         
 
          
          	 [bookmark: pgfId-4154415]select one or more events whose packets you want to view, and, at the bottom of the page, click  View. 
 
          	 [bookmark: pgfId-4154416]at the bottom of the page, click  View All  to view the packets for all events that match the current constraints.
 
         
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-4154418]Tip At any point in the process, you can save the constraints as a set of search criteria. For example, if you find that over the course of a few days your network is being probed by an attacker from a single IP address, you can save your constraints during your investigation and then use them again later. You cannot, however, save compound constraints as a set of search criteria. For more information, see Performing and Saving Searches.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-4284846]Tip If no intrusion events appear on the event views, adjusting the selected time range might return results. If you selected an older time range, events in that time range might have been deleted. Adjusting the rule thresholding configuration might generate events. 
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4241108][bookmark: 82526]Using the Packet[bookmark: marker-4241107] View
 
    [bookmark: pgfId-4241113]License: Protection
 
    [bookmark: pgfId-4241114]A packet view provides information about the packet that triggered the rule that generated an intrusion event.
 
     
      
    
 
    
 
    [bookmark: pgfId-4185873]Tip The packet view on a Defense Center does not contain packet information when the Transfer Packet option is disabled for the device detecting the event.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3502640]The packet view indicates why a specific packet was captured by providing information about the intrusion event that the packet triggered, including the event’s time stamp, message, classification, priority, and, if the event was generated by a standard text rule, the rule that generated the event. The packet view also provides general information about the packet, such as its size.
 
    [bookmark: pgfId-2584264]In addition, the packet view has a section that describes each layer in the packet: data link, network, and transport, as well as a section that describes the bytes that comprise the packet. If the system decrypted the packet, you can view the decrypted bytes. You can expand collapsed sections to display detailed information. 
 
     
      
    
 
    
 
    [bookmark: pgfId-2242714]Note Because each portscan event is triggered by multiple packets, portscan events use a special version of the packet view. See Detecting Portscans for more information.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-2940647]Table 41-5 [bookmark: 85900]Packet View Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-2940651]To... 
         
  
        	 
          
          [bookmark: pgfId-2940653]You can... 
         
  
       
 
        
        	[bookmark: pgfId-2940655]modify the date and time range in the packet views
  
        	[bookmark: pgfId-2940660]find more information in Setting Event Time Constraints.
  
       
 
        
        	[bookmark: pgfId-2940662]learn more about the information displayed in the packet view
  
        	[bookmark: pgfId-2940664]find more information in:
 
          
          	 [bookmark: pgfId-2940668]Viewing Event Information
 
          	 [bookmark: pgfId-2940672]Viewing Frame Information
 
          	 [bookmark: pgfId-2940676]Viewing Data Link Layer Information
 
          	 [bookmark: pgfId-2940680]Viewing Network Layer Information
 
          	 [bookmark: pgfId-2940684]Viewing Transport Layer Information
 
          	 [bookmark: pgfId-2940688]Viewing Packet Byte Information
 
         
  
       
 
        
        	[bookmark: pgfId-2940691]add[bookmark: marker-2940690] an event to the clipboard so you can transfer it to the incidents at a later time
  
        	[bookmark: pgfId-4205158]either:
 
          
          	 [bookmark: pgfId-4205159]click  Copy to copy the event whose packet you are viewing
 
          	 [bookmark: pgfId-4205160]click  Copy All to copy all the events whose packets you previously selected
 
         
 [bookmark: pgfId-2940699]The clipboard stores up to 25,000 events per user. For more information on the clipboard, see Using the Clipboard.
  
       
 
        
        	[bookmark: pgfId-3503252]del[bookmark: marker-3503251]ete an event from the event database
  
        	[bookmark: pgfId-3503277]either:
 
          
          	 [bookmark: pgfId-3503278]click  Delete to delete the event whose packet you are viewing
 
          	 [bookmark: pgfId-3503254]click  Delete All to delete all the events whose packets you previously selected
 
         
  
       
 
        
        	[bookmark: pgfId-3503319]mark an event reviewed to remove it from event views, but not the event database.
  
        	[bookmark: pgfId-3503379]either:
 
          
          	 [bookmark: pgfId-3503380]click  Review to review the event whose packet you are viewing
 
          	 [bookmark: pgfId-3503381]click  Review All to review all the events whose packets you previously selected 
 
         
 [bookmark: pgfId-3503325]For more information, see Reviewing Intrusion Events. Note that reviewed events continue to be included in the event statistics on the Intrusion Event Statistics page.
  
       
 
        
        	[bookmark: pgfId-3503351]download a local copy of the packet (a packet capture file in libpcap format) that triggered the event
  
        	[bookmark: pgfId-3503353]either:
 
          
          	 [bookmark: pgfId-3503542]click  Download Packet  to save a copy of the captured packet for the event you are viewing
 
          	 [bookmark: pgfId-3503572]click  Download All Packets  to save copies of the captured packets for all the events whose packets you previously selected
 
         
 [bookmark: pgfId-3503354]The captured packet is saved in libpcap format. This format is used by several popular protocol analyzers. 
 [bookmark: pgfId-3503355]Note that you cannot download a portscan packet because single portscan events are based on multiple packets; however, the portscan view provides all usable packet information. See Understanding Portscan Events for more information.
 [bookmark: pgfId-3503359]Note that you must have at least 15% available disk space in order to download.
  
       
 
        
        	[bookmark: pgfId-2940726]expand or collapse a page section
  
        	[bookmark: pgfId-2940728]click the arrow next to the section.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-4154477]To display the packet view:
 
    [bookmark: pgfId-4198012]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-4154482]Step 1 On the table view of intrusion events, select packets to view. See the Constraining Events on the Table View of Events table for more information.
 
    [bookmark: pgfId-4154486]The packet view appears. If you selected more than one event, you can page through the packets by using the page numbers at the bottom of the page.
 
    [bookmark: pgfId-4373588]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-2243252][bookmark: 44494]Viewing Event[bookmark: marker-2556841] Information
 
     [bookmark: pgfId-4183616]License: Protection
 
     [bookmark: pgfId-4355506]On the packet view, you can view information about the packet in the Event Information section.
 
     [bookmark: pgfId-3855441]Event
 
     [bookmark: pgfId-3614527]The event message. For rule-based events, this corresponds to the rule message. For other events, this is determined by the decoder or preprocessor.
 
     [bookmark: pgfId-4205243]The ID for the event is appended to the message in the format (GID:SID:Rev). GID is the generator ID of the rules engine, the decoder, or the preprocessor that generated the event. SID is the identifier for the rule, decoder message, or preprocessor message. Rev is the revision number of the rule. For more information, refer to Reading Preprocessor Generator IDs.
 
     [bookmark: pgfId-4205247]Timestamp
 
     [bookmark: pgfId-4205279]The time that the packet was captured.
 
     [bookmark: pgfId-4154533]Classification
 
     [bookmark: pgfId-4154534]The event classification. For rule-based events, this corresponds to the rule classification. For other events, this is determined by the decoder or preprocessor.
 
     [bookmark: pgfId-3614538]Priority
 
     [bookmark: pgfId-3614540]The event priority. For rule-based events, this corresponds to either the value of the priority keyword or the value for the classtype keyword. For other events, this is determined by the decoder or preprocessor.
 
     [bookmark: pgfId-4210087]Ingress Security Zone
 
     [bookmark: pgfId-4210088]The ingress security zone of the packet that triggered the event. Only this security zone field is populated in a passive deployment. See Working with Security Zones.
 
     [bookmark: pgfId-4210089]Egress Security Zone
 
     [bookmark: pgfId-4205343]For an inline deployment, the egress security zone of the packet that triggered the event. See Working with Security Zones.
 
     [bookmark: pgfId-4205347]Device
 
     [bookmark: pgfId-4154539]The managed device where the access control policy was applied. See Managing Devices.
 
     [bookmark: pgfId-4375487]Security Context
 
     [bookmark: pgfId-4375488]The metadata identifying the virtual firewall group through which the traffic passed. Note that the system only populates this field for ASA FirePOWER devices in multiple context mode.
 
     [bookmark: pgfId-4356483]Ingress Interface
 
     [bookmark: pgfId-4205417]The ingress interface of the packet that triggered the event. Only this interface column is populated for a passive interface. See Configuring Sensing Interfaces.
 
     [bookmark: pgfId-4210167]Egress Interface
 
     [bookmark: pgfId-4210168]For an inline set, the egress interface of the packet that triggered the event. See Configuring Sensing Interfaces.
 
     [bookmark: pgfId-4210169]Source/Destination IP
 
     [bookmark: pgfId-4294646]The host IP address or domain name where the packet that triggered the event (source) originated, or the target (destination) host of the traffic that triggered the event. 
 
     [bookmark: pgfId-4296576]Note that to display the domain name, you must enable IP address resolution; for more information, see Configuring Event View Settings.
 
     [bookmark: pgfId-4296580]Click the address or domain name to view the context menu, then select Whois to do a whois search on the host, View Host Profile to view host information, or Blacklist Now or Whitelist Now to add the address to a global blacklist or whitelist. See Using Host Profiles and Working with the Global Whitelist and Blacklist.
 
     [bookmark: pgfId-4294639]Source Port/ICMP Type
 
     [bookmark: pgfId-4158967]Source port of the packet that triggered the event. For ICMP traffic, where there is no port number, the system displays the ICMP type.
 
     [bookmark: pgfId-4230437]Destination Port/ICMP Code
 
     [bookmark: pgfId-4253972]The port number for the host receiving the traffic. For ICMP traffic, where there is no port number, the system displays the ICMP code.
 
     [bookmark: pgfId-4253979]Email Headers
 
     [bookmark: pgfId-4165411]The data that was extracted from the email header. Note that email headers do not appear in the table view of intrusion events, but you can use email header data as a search criterion. 
 
     [bookmark: pgfId-4165412]To associate email headers with intrusion events for SMTP traffic, you must enable the SMTP preprocessor Log Headers option. See Understanding SMTP Decoding for more information. For rule-based events, this row appears when email data is extracted.
 
     [bookmark: pgfId-4165416]HTTP Hostname
 ) to display the complete host name when longer than a single row. 
     
 
     [bookmark: pgfId-4165418]To display host names, you must enable the HTTP Inspect preprocessor Log Hostname option. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4165422]Note that HTTP request packets do not always include a host name. For rule-based events, this row appears when the packet contains the HTTP host name or the HTTP URI.
 
     [bookmark: pgfId-4165423]HTTP URI
 ) to display the complete URI when it is longer than a single row. 
     
 
     [bookmark: pgfId-4165425]To display the URI, you must enable the HTTP Inspect preprocessor Log URI option. See Selecting Server-Level HTTP Normalization Options for more information.
 
     [bookmark: pgfId-4165429]Note that HTTP request packets do not always include a URI. For rule-based events, this row appears when the packet contains the HTTP host name or the HTTP URI.
 
     [bookmark: pgfId-4311103]To see the associated HTTP URI in intrusion events triggered by HTTP responses, you should configure HTTP server ports in the Perform Stream Reassembly on Both Ports option; note, however, that this increases resource demands for traffic reassembly. See Selecting Stream Reassembly Options.
 
     [bookmark: pgfId-4217440]Intrusion Policy
 
     [bookmark: pgfId-4217441]The intrusion policy, if present, where the intrusion, preprocessor, or decoder rule that generated the intrusion event was enabled. You can select an intrusion policy as the default action for an access control policy or associate an intrusion policy with an access control rule. See Setting Default Handling and Inspection for Network Traffic and Configuring an Access Control Rule to Perform Intrusion Prevention.
 
     [bookmark: pgfId-4257901]Access Control Policy
 
     [bookmark: pgfId-4257902]The access control policy that includes the intrusion policy where the intrusion, preprocessor, or decoder rule that generated the event is enabled. See Managing Access Control Policies.
 
     [bookmark: pgfId-4257906]Access Control Rule
 
     [bookmark: pgfId-4257907]The access control rule associated with an intrusion rule that generated the event; see Configuring an Access Control Rule to Perform Intrusion Prevention. Default Action indicates that the intrusion policy where the rule is enabled is not associated with an access control rule but, instead, is configured as the default action of the access control policy; see Setting Default Handling and Inspection for Network Traffic.
 
     [bookmark: pgfId-4165430]Rule
 
     [bookmark: pgfId-3614578]For standard text rule events, the rule that generated the event. 
 
     [bookmark: pgfId-4047784]Note that if the event is based on a shared object rule, a decoder, or a preprocessor, the rule is not available. 
 
     [bookmark: pgfId-4283888]Because rule data may contain sensitive information about your network, administrators may toggle users’ ability to view rule information in the packet view with the View Local Rules permission in the user role editor. For more information, see Modifying User Privileges and Options.
 
     [bookmark: pgfId-3614595]Actions
 
     [bookmark: pgfId-4154605]For standard text rule events, expand Actions to take any of the following actions on the rule that triggered the event:
 
     [bookmark: pgfId-4314792] – edit the rule
 
     [bookmark: pgfId-4314806] – view documentation for the revision of the rule
 
     [bookmark: pgfId-4314826] – add a comment to the rule
 
     [bookmark: pgfId-4314853] – change the state of the rule
 
     [bookmark: pgfId-4314858] – set a threshold for the rule
 
     [bookmark: pgfId-4314903] – suppress the rule
 
     [bookmark: pgfId-4165519]See Using Packet View Actions, Setting Threshold Options within the Packet View, and Setting Suppression Options within the Packet View for more information.
 
     [bookmark: pgfId-4314923]Note that if the event is based on a shared object rule, a decoder, or a preprocessor, the rule is not available. 
 
    
 
     
      [bookmark: pgfId-4210600][bookmark: 32059]Using Packet Vie[bookmark: marker-4210599]w Actions
 
     [bookmark: pgfId-4210601]License: Protection
 
     [bookmark: pgfId-4074042]On the packet view, you can take several actions in the Event Information section on the rule that triggered the event. Note that if the event is based on a shared object rule, a decoder, or a preprocessor, the rule is not available. You must expand Actions to display rule actions.
 
     [bookmark: pgfId-4154637]Edit
 
     [bookmark: pgfId-4154641]For standard text rule events, click Edit to modify the rule that generated the event.
 
     [bookmark: pgfId-4154645]Note that if the event is based on a shared object rule, a decoder, or a preprocessor, the rule is not available.
 
      
       
     
 
     
 
     [bookmark: pgfId-4154651]Note If you edit a rule provided by Cisco (as opposed to a custom standard text rule), you actually create a new local rule. Make sure you set the local rule to generate events and also disable the original rule in the current intrusion policy. Note, however, that you cannot enable local rules in the default policies. For more information, see Modifying Existing Rules.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4154656]View Documentation
 
     [bookmark: pgfId-4154660]For standard text rule events, click View Documentation to learn more about the rule revision that generated the event.
 
     [bookmark: pgfId-4154661]Rule Comment
 
     [bookmark: pgfId-4154665]For standard text rule events, click Rule Comment to add a text comment to the rule that generated the event.
 
     [bookmark: pgfId-4154666]This allows you to provide additional context and information about the rule and the exploit or policy violation it identifies. You can also add and view rule comments in the rule editor. For more information, see Adding Comments to Rules.
 
     [bookmark: pgfId-3615171]Disable this rule
 
     [bookmark: pgfId-3615173]If this event is generated by a standard text rule, you can disable the rule, if necessary. You can set the rule in all policies that you can edit locally. Alternately, you can set the rule only in the current policy (that is, the policy that generated the event) if you can edit the current policy locally.
 
     [bookmark: pgfId-3615178]For more information, see Setting Rule States. 
 
     [bookmark: pgfId-4210944]Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by Cisco.
 
      
       
     
 
     
 
     [bookmark: pgfId-3615183]Note You cannot disable shared object rules from the packet view, nor can you disable rules in the default policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3615185]Set this rule to generate events
 
     [bookmark: pgfId-3615187]If this event is generated by a standard text rule, you can set the rule to generate events in all policies that you can edit locally. Alternately, you can set the rule only in the current policy (that is, the policy that generated the event) if you can edit the current policy locally.
 
     [bookmark: pgfId-3615192]For more information, see Setting Rule States. 
 
     [bookmark: pgfId-4211003]Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by Cisco.
 
      
       
     
 
     
 
     [bookmark: pgfId-3615197]Note You cannot set shared object rules to generate events from e packet view, nor can you disable rules in the default policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3615199]Set this rule to drop
 
     [bookmark: pgfId-3615204]If your managed device is deployed inline on your network, you can set the rule that triggered the event to drop packets that trigger the rule in all policies that you can edit locally. Alternately, you can set the rule only in the current policy (that is, the policy that generated the event) if you can edit the current policy locally.
 
     [bookmark: pgfId-4211041]Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by Cisco. Note also that this option appears only when Drop when Inline is enabled in the current policy. See Setting Drop Behavior in an Inline Deployment for more information.
 
     [bookmark: pgfId-4314620]Set Thresholding Options
 
     [bookmark: pgfId-4314621]You can use this option to create a threshold for the rule that triggered this even in all policies that you can edit locally. Alternately, you create a threshold only for the current policy (that is, the policy that generated the event) if you can edit the current policy locally.
 
     [bookmark: pgfId-4314624]The thresholding options are described in Setting Threshold Options within the Packet View.
 
     [bookmark: pgfId-4314626]Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default intrusion policy provided by Cisco.
 
     [bookmark: pgfId-4314630]Set Suppression Options
 
     [bookmark: pgfId-4314631]You can use this object to suppress the rule that triggered this event in all policies that you can edit locally. Alternately, you can suppress the rule only in the current policy (that is, the policy that generated the event) if you can edit the current policy locally.
 
     [bookmark: pgfId-4314634]The suppression options are described in Setting Suppression Options within the Packet View.
 
     [bookmark: pgfId-4314636]Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by Cisco.
 
    
 
     
      [bookmark: pgfId-2941309][bookmark: 90881]Setting Threshold Options within[bookmark: marker-2941308] the Packet View
 
     [bookmark: pgfId-4183646]License: Protection
 
     [bookmark: pgfId-2497894]You can control the number of events that are generated per rule over time by setting the threshold options in the packet view of an intrusion event. You can set threshold options in all policies that you can edit locally or, when it can be edited locally, only in the in the current policy (that is, the policy that caused the event to be generated).
 
     [bookmark: pgfId-2844175]To set the threshold options within the packet view:
 
     [bookmark: pgfId-4198035]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-2844177]Step 1 Within the packet view of an intrusion event that was generated by an intrusion rule, expand Actions in the Event Information section; expand Set Thresholding Options and select one of the two possible options:
 
      
       
       	 [bookmark: pgfId-2501546] in the current policy 
 
       	 [bookmark: pgfId-2501547] in all locally created policies 
 
      
 
     
 
     [bookmark: pgfId-4210659]Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by Cisco.
 
     [bookmark: pgfId-2501548]The thresholding options appear.
 
     [bookmark: pgfId-2501742]Step 2 Select the type of threshold you want to set:
 
      
       
       	 [bookmark: pgfId-2501743]Select  limit to limit notification to the specified number of event instances per time period.
 
       	 [bookmark: pgfId-2501744]Select  threshold to provide notification for each specified number of event instances per time period.
 
       	 [bookmark: pgfId-2501745]Select  both to provide notification once per time period after a specified number of event instances.
 
      
 
     
 
     [bookmark: pgfId-2501746]Step 3 Select the appropriate radio button to indicate whether you want the event instances tracked by Source or Destination IP address.
 
     [bookmark: pgfId-2501747]Step 4 In the Count field, type the number of event instances you want to use as your threshold.
 
     [bookmark: pgfId-2501748]Step 5 In the Seconds field, type a number between 1 and 86400 that specifies the time period for which event instances are tracked.
 
     [bookmark: pgfId-2501792]Step 6 If you want to override any current thresholds for this rule in existing intrusion policies, select Override any existing settings for this rule.
 
     [bookmark: pgfId-4185945]Step 7 Click Save Thresholding.
 
     [bookmark: pgfId-4185949]The system adds your threshold and displays a message indicating success. If you chose not to override existing settings, a message appears informing you of any conflicts.
 
     [bookmark: pgfId-4373594]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4185933][bookmark: 59467]Setting Suppression Options within[bookmark: marker-4185932] the Packet View
 
     [bookmark: pgfId-4185937]License: Protection
 
     [bookmark: pgfId-4316849]You can use the suppression options to suppress intrusion events altogether, or based on the source or destination IP address. You can set suppression options in all policies that you can edit locally. Alternately, you can set suppression options only in the current policy (that is, the policy that generated the event) when the current policy can be edited locally.
 
     [bookmark: pgfId-2930360]To suppress intrusion events within the packet view:
 
     [bookmark: pgfId-4198052]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-3441152]Step 1 Within the packet view of an intrusion event that was generated by an intrusion rule, expand Actions in the Event Information section; expand Set Suppression Options and click one of the two possible options:
 
      
       
       	 [bookmark: pgfId-3441153] in the current policy 
 
       	 [bookmark: pgfId-3441154] in all locally created policies 
 
      
 
     
 
     [bookmark: pgfId-4210688]Note that the current policy option appears only when you can edit the current policy; for example, you can edit a custom policy, but you cannot edit a default policy provided by Cisco.
 
     [bookmark: pgfId-2501297]The suppression options appear.
 
     [bookmark: pgfId-2501290]Step 2 Select one of the following Track By options:
 
      
       
       	 [bookmark: pgfId-3423438]To completely suppress events for the rule that triggered this event, select  Rule .
 
       	 [bookmark: pgfId-3420108]To suppress events generated by packets originating from a specified source IP address, select  Source .
 
       	 [bookmark: pgfId-2501292]To suppress events generated by packets going to a specified destination IP address, select  Destination .
 
      
 
     
 
     [bookmark: pgfId-2501293]Step 3 In the IP address or CIDR block field, enter the IP address or CIDR block/prefix length you want to specify as the source or destination IP address.
 
     [bookmark: pgfId-3535837]For information on using CIDR notation and prefix lengths in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-3425770]Step 4 Click Save Suppression.
 
     [bookmark: pgfId-3425771]The suppression options within your intrusion policies are modified according to your specifications. If you chose not to override existing settings, a message appears informing you of any conflicts.
 
     [bookmark: pgfId-4373603]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2497829][bookmark: 24216]Viewing Fra[bookmark: marker-1100755]me Information
 
     [bookmark: pgfId-4205943]License: Protection
 
     [bookmark: pgfId-4205944]On the packet view, click the arrow next to Frame to view information about the captured frame. The packet view may display a single frame or multiple frames. Each frame provides information about an individual network packet. You would see multiple frames, for example, in the case of tagged packets or packets in reassembled TCP streams. For information on tagged packets, see Evaluating Post-Attack Traffic. For information on reassembled TCP streams, see Reassembling TCP Streams. 
 
     [bookmark: pgfId-3615552]Frame n
 
     [bookmark: pgfId-3615554]The captured frame, where n is 1 for single-frame packets and the incremental frame number for multi-frame packets. The number of captured bytes in the frame is appended to the frame number.
 
     [bookmark: pgfId-3615556]Arrival Time
 
     [bookmark: pgfId-3615558]The date and time the frame was captured.
 
     [bookmark: pgfId-3615560]Time delta from previous captured frame
 
     [bookmark: pgfId-3615562]For multi-frame packets, the elapsed time since the previous frame was captured.
 
     [bookmark: pgfId-4205964]Time delta from previous displayed frame
 
     [bookmark: pgfId-4206747]For multi-frame packets, the elapsed time since the previous frame was displayed.
 
     [bookmark: pgfId-4206035]Time since reference or first frame
 
     [bookmark: pgfId-4206761]For multi-frame packets, the elapsed time since the first frame was captured.
 
     [bookmark: pgfId-3615564]Frame Number
 
     [bookmark: pgfId-3615566]The incremental frame number.
 
     [bookmark: pgfId-3615568]Frame Length
 
     [bookmark: pgfId-3615570]The length of the frame in bytes.
 
     [bookmark: pgfId-4206057]Capture Length
 
     [bookmark: pgfId-4206791]The length of the captured frame in bytes.
 
     [bookmark: pgfId-4206833]Frame is marked
 
     [bookmark: pgfId-4206870]Whether the frame is marked (true or false).
 
     [bookmark: pgfId-4206835]Protocols in frame
 
     [bookmark: pgfId-3615574]The protocols included in the frame.
 
    
 
     
      [bookmark: pgfId-2931083][bookmark: 67370]Viewing Da[bookmark: marker-1100756]ta Link Layer Information
 
     [bookmark: pgfId-4183708]License: Protection
 
     [bookmark: pgfId-1360717]On the packet view, click the arrow next to the data link layer protocol (for example, Ethernet II) to view the data link layer information about the packet, which contains the 48-bit media access control (MAC) addresses for the source and destination hosts. It may also display other information about the packet, depending on the hardware protocol.
 
      
       
     
 
     
 
     [bookmark: pgfId-2940530]Note Note that this example discusses Ethernet link layer information; other protocols may also appear.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3830983]The packet view reflects the protocol used at the data link layer. The following listing describes the information you might see for an Ethernet II or IEEE 802.3 Ethernet packet in the packet view. 
 
     [bookmark: pgfId-3615661]Destination
 
     [bookmark: pgfId-3615665]The MAC address for the destination host.
 
      
       
     
 
     
 
     [bookmark: pgfId-3615673]Note Ethernet can also use multicast and broadcast addresses as the destination address.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3615676]Source
 
     [bookmark: pgfId-3615680]The MAC address for the source host.
 
     [bookmark: pgfId-3615690]Type
 
     [bookmark: pgfId-4117984]For Ethernet II packets, the type of packet that is encapsulated in the Ethernet frame; for example, IPv6 or ARP datagrams. Note that this item only appears for Ethernet II packets. 
 
     [bookmark: pgfId-4117985]Length
 
     [bookmark: pgfId-3615697]For IEEE 802.3 Ethernet packets, the total length of the packet, in bytes, not including the checksum. Note that this item only appears for IEEE 802.3 Ethernet packets.
 
    
 
     
      [bookmark: pgfId-1093154][bookmark: 87402]Viewing Ne[bookmark: marker-1100759]twork Layer Information
 
     [bookmark: pgfId-4183724]License: Protection
 
     [bookmark: pgfId-2940513]On the packet view, click the arrow next to the network layer protocol (for example, Internet Protocol) to view more detailed information about network layer information related to the packet.
 
      
       
     
 
     
 
     [bookmark: pgfId-2940514]Note Note that this example discusses IP packets; other protocols may also appear.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4163365]See the following sections for more information:
 
      
      	 [bookmark: pgfId-4163369]Viewing IPv4 Network Layer Information
 
      	 [bookmark: pgfId-4163373]Viewing IPv6 Network Layer Information
 
     
 
    
 
     
      [bookmark: pgfId-4163375][bookmark: 77554]Viewing IPv4 Network Layer Information
 
     [bookmark: pgfId-4183740]License: Protection
 
     [bookmark: pgfId-4117995]The following listing describes protocol-specific information that might appear in an IPv4 packet.
 
     [bookmark: pgfId-3615793]Version
 
     [bookmark: pgfId-3615795]The Internet Protocol version number.
 
     [bookmark: pgfId-3615798]Header Length
 
     [bookmark: pgfId-3615800]The number of bytes in the header, including any IP options. An IP header with no options is 20 bytes long.
 
     [bookmark: pgfId-3615803]Differentiated Services Field
 
     [bookmark: pgfId-3615805]The values for differentiated services that indicate how the sending host supports Explicit Congestion Notification (ECN):
 
     [bookmark: pgfId-3615806] – 0x0 — does not support ECN-Capable Transport (ECT)
 
     [bookmark: pgfId-3615807] – 0x1 and 0x2 — supports ECT
 
     [bookmark: pgfId-3615808] – 0x3 — Congestion Experienced (CE)
 
     [bookmark: pgfId-3615812]Total Length
 
     [bookmark: pgfId-3615814]The length of the IP packet, in bytes, minus the IP header.
 
     [bookmark: pgfId-3615817]Identification
 
     [bookmark: pgfId-3615819]The value that uniquely identifies an IP datagram sent by the source host. This value is used to trace fragments of the same datagram.
 
     [bookmark: pgfId-3615822]Flags
 
     [bookmark: pgfId-3615824]The values that control IP fragmentation, where:
 
     [bookmark: pgfId-3615825]values for the Last Fragment flag indicate whether there are more fragments associated with the datagram:
 
     [bookmark: pgfId-3615826] – 0 — there are no more fragments associated with the datagram
 
     [bookmark: pgfId-3615827] – 1 — there are more fragments associated with the datagram
 
     [bookmark: pgfId-3615828]values for the Don’t Fragment flag control whether the datagram can be fragmented:
 
     [bookmark: pgfId-3615829] – 0 — the datagram can be fragmented
 
     [bookmark: pgfId-3615830] – 1 — the datagram must not be fragmented
 
     [bookmark: pgfId-3615833]Fragment Offset
 
     [bookmark: pgfId-3615835]The value for the fragment offset from the beginning of the datagram.
 
     [bookmark: pgfId-3615838]Time to Live (ttl)
 
     [bookmark: pgfId-3615840]The remaining number of hops that the datagram can make between routers before the datagram expires.
 
     [bookmark: pgfId-3615843]Protocol
 
     [bookmark: pgfId-3615845]The transport protocol that is encapsulated in the IP datagram; for example, ICMP, IGMP, TCP, or UDP.
 
     [bookmark: pgfId-3615847]Header Checksum
 
     [bookmark: pgfId-4296874]The indicator for whether the IP checksum is valid. If the checksum is invalid, the datagram may have been corrupted during transit or may be being used in an intrusion evasion attempt.
 
     [bookmark: pgfId-4296875]Source/Destination
 
     [bookmark: pgfId-4296876]The IP address or domain name for the source (or destination) host.
 
     [bookmark: pgfId-4154849]Note that to display the domain name, you must enable IP address resolution; for more information, see Configuring Event View Settings.
 
     [bookmark: pgfId-4154853]Click the address or domain name to view the context menu, then select Whois to do a whois search on the host, View Host Profile to view host information, or Blacklist Now or Whitelist Now to add the address to a global blacklist or whitelist. See Using Host Profiles and Working with the Global Whitelist and Blacklist.
 
    
 
     
      [bookmark: pgfId-4163404][bookmark: 97225]Viewing IPv6 Network Layer Information
 
     [bookmark: pgfId-4183756]License: Protection
 
     [bookmark: pgfId-4163424]The following listing describes protocol-specific information that might appear in an IPv6 packet.
 
     [bookmark: pgfId-4163425]Traffic Class
 
     [bookmark: pgfId-4163426]An experimental 8-bit field in the IPv6 header for identifying IPv6 packet classes or priorities similar to the differentiated services functionality provided for IPv4. When unused, this field is set to zero.
 
     [bookmark: pgfId-4163427]Flow Label
 
     [bookmark: pgfId-4163428]A optional 20-bit IPv6 hexadecimal value 1 to FFFFF that identifies a special flow such as non-default quality of service or real-time service. When unused, this field is set to zero.
 
     [bookmark: pgfId-4163429]Payload Length
 
     [bookmark: pgfId-4163430]A 16-bit field identifying the number of octets in the IPv6 payload, which is comprised of all of the packet following the IPv6 header, including any extension headers.
 
     [bookmark: pgfId-4163431]Next Header
 
     [bookmark: pgfId-4163432]An 8-bit field identifying the type of header immediately following the IPv6 header, using the same values as the IPv4 Protocol field.
 
     [bookmark: pgfId-4163433]Hop Limit
 
     [bookmark: pgfId-4163434]An 8-bit decimal integer that each node that forwards the packet decrements by one. The packet is discarded if the decremented value reaches zero.
 
     [bookmark: pgfId-4163435]Source
 
     [bookmark: pgfId-4163436]The 128-bit IPv6 address for the source host.
 
     [bookmark: pgfId-4163437]Destination
 
     [bookmark: pgfId-4163438]The 128-bit IPv6 address for the destination host.
 
    
 
     
      [bookmark: pgfId-1359701][bookmark: 81864]Viewing Trans[bookmark: marker-1127889]port Layer Information
 
     [bookmark: pgfId-4183772]License: Protection
 
     [bookmark: pgfId-1359502]On the packet view, click the arrow next to the transport layer protocol (for example, TCP, UDP, or ICMP) to view more information about the packet.
 
      
       
     
 
     
 
     [bookmark: pgfId-2943361]Tip Click Data when present to view the first twenty-four bytes of the payload for the protocol immediately above it in the Packet Information section of the packet view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2943340]The contents of the transport layer for each of the following protocols is described below:
 
      
      	 [bookmark: pgfId-1338192]TCP Packet View
 
      	 [bookmark: pgfId-1338236]UDP Packet View
 
      	 [bookmark: pgfId-1338258]ICMP Packet View
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2940540]Note Note that these examples discuss TCP, UDP, and ICMP packets; other protocols may also appear.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1359548][bookmark: 85432]TCP P[bookmark: marker-1359547]acket View
 
     [bookmark: pgfId-4183788]License: Protection
 
     [bookmark: pgfId-1359556]This section describes the protocol-specific information for a TCP packet.
 
     [bookmark: pgfId-3616320]Source port
 
     [bookmark: pgfId-3616322]The number that identifies the originating application protocol.
 
     [bookmark: pgfId-3616325]Destination port
 
     [bookmark: pgfId-3616327]The number that identifies the receiving application protocol.
 
     [bookmark: pgfId-3616330]Sequence number
 
     [bookmark: pgfId-3616332]The value for the first byte in the current TCP segment, keyed to initial sequence number in the TCP stream.
 
     [bookmark: pgfId-3616334]Next sequence number
 
     [bookmark: pgfId-3616336]In a response packet, the sequence number of the next packet to send.
 
     [bookmark: pgfId-3616339]Acknowledgement number
 
     [bookmark: pgfId-3616341]The TCP acknowledgement, which is keyed to the sequence number of the previously accepted data.
 
     [bookmark: pgfId-3616344]Header Length
 
     [bookmark: pgfId-3616346]The number of bytes in the header.
 
     [bookmark: pgfId-3616349]Flags
 
     [bookmark: pgfId-3616351]The six bits that indicate the TCP segment’s transmission state:
 
     [bookmark: pgfId-3616352] – U — the urgent pointer is valid
 
     [bookmark: pgfId-3616353] – A — the acknowledgement number is valid
 
     [bookmark: pgfId-3616354] – P — the receiver should push data
 
     [bookmark: pgfId-3616355] – R — reset the connection
 
     [bookmark: pgfId-3616356] – S — synchronize sequence numbers to start a new connection
 
     [bookmark: pgfId-3616357] – F — the sender has finished sending data
 
     [bookmark: pgfId-4283134]Window size
 
     [bookmark: pgfId-4283135]The amount of unacknowledged data, in bytes, that the receiving host will accept.
 
     [bookmark: pgfId-3616366]Checksum
 
     [bookmark: pgfId-3616368]The indicator for whether the TCP checksum is valid. If the checksum is invalid, the datagram may have been corrupted during transit or may be being used in an in evasion attempt.
 
     [bookmark: pgfId-3616372]Urgent Pointer
 
     [bookmark: pgfId-3616374]The position, if present, in the TCP segment where the urgent data ends. Used in conjunction with the U flag.
 
     [bookmark: pgfId-3616377]Options
 
     [bookmark: pgfId-3616379]The values, if present, for TCP options.
 
    
 
     
      [bookmark: pgfId-3831085][bookmark: 38171]UDP Pa[bookmark: marker-3831083]cket View
 
     [bookmark: pgfId-4183804]License: Protection
 
     [bookmark: pgfId-1091854]This section describes the protocol-specific information for a UDP packet.
 
     [bookmark: pgfId-3616883]Source port
 
     [bookmark: pgfId-3616885]The number that identifies the originating application protocol.
 
     [bookmark: pgfId-3616888]Destination port
 
     [bookmark: pgfId-3616890]The number that identifies the receiving application protocol.
 
     [bookmark: pgfId-3616893]Length
 
     [bookmark: pgfId-3616895]The combined length of the UDP header and data.
 
     [bookmark: pgfId-3616898]Checksum
 
     [bookmark: pgfId-3616900]The indicator for whether the UDP checksum is valid. If the checksum is invalid, the datagram may have been corrupted during transit.
 
    
 
     
      [bookmark: pgfId-1090973][bookmark: 37113]ICMP Packet View
 
     [bookmark: pgfId-4183820]License: Protection
 
     [bookmark: pgfId-3617016]This section describes the protocol-specific information for an ICMP packet.
 
     [bookmark: pgfId-3617025]Type
 
     [bookmark: pgfId-3616971]The type of ICMP message:
 
     [bookmark: pgfId-3616972] – 0 — echo reply
 
     [bookmark: pgfId-3616973] – 3 — destination unreachable
 
     [bookmark: pgfId-3616974] – 4 — source quench
 
     [bookmark: pgfId-3616975] – 5 — redirect
 
     [bookmark: pgfId-3616976] – 8 — echo request
 
     [bookmark: pgfId-3616977] – 9 — router advertisement
 
     [bookmark: pgfId-3616978] – 10 — router solicitation
 
     [bookmark: pgfId-3616979] – 11 — time exceeded
 
     [bookmark: pgfId-3616980] – 12 — parameter problem
 
     [bookmark: pgfId-3616981] – 13 — timestamp request
 
     [bookmark: pgfId-3616982] – 14 — timestamp reply
 
     [bookmark: pgfId-3616983] – 15 — information request (obsolete)
 
     [bookmark: pgfId-3616984] – 16 — information reply (obsolete)
 
     [bookmark: pgfId-3616985] – 17 — address mask request
 
     [bookmark: pgfId-3616986] – 18 — address mask reply
 
     [bookmark: pgfId-3616989]Code
 
     [bookmark: pgfId-3623502]The accompanying code for the ICMP message type. ICMP message types 3, 5, 11, and 12 have corresponding codes as described in RFC 792.
 
     [bookmark: pgfId-4206130]Checksum
 
     [bookmark: pgfId-4206228]The indicator for whether the ICMP checksum is valid. If the checksum is invalid, the datagram may have been corrupted during transit.
 
    
 
     
      [bookmark: pgfId-4206233][bookmark: 20391]Viewing Pack[bookmark: marker-4206232]et Byte Information
 
     [bookmark: pgfId-4183840]License: Protection
 
     [bookmark: pgfId-2330276]On the packet view, click the arrow next to Packet Bytes to view hexadecimal and ASCII versions of the bytes that comprise the packet. If the system decrypted traffic, you can view the decrypted packet bytes.
 
    
 
   
 
    
     [bookmark: pgfId-4155029][bookmark: 46081]Using Impa[bookmark: marker-4155027]ct Levels to Evaluate Events
 
    [bookmark: pgfId-4183860]License: Protection
 
    [bookmark: pgfId-4155063]To help you evaluate the impact an event has on your network, the Defense Center displays an impact level in the table view of intrusion events. For each event, the Defense Center adds an impact level icon whose color indicates the correlation between intrusion data, network discovery data, and vulnerability information.
 
     
      
    
 
    
 
    [bookmark: pgfId-4155073]Note Because there is no operating system information available for hosts added to the network map based on NetFlow data, the Defense Center cannot assign impact Vulnerable (impact level 1: red) impact levels for intrusion events involving those hosts, unless you use the host input feature to manually set the hosts’ operating system identity.
 
     
     
 
    
 
    
 
     
     
 
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-4155088]Table 41-6 [bookmark: 39945]Impact Levels 
 
       
       
        
        	 
          
          [bookmark: pgfId-4155094]Impact Level 
         
  
        	 
          
          [bookmark: pgfId-4261996]Vulnerability 
         
  
        	 
          
          [bookmark: pgfId-4155096]Color 
         
  
        	 
          
          [bookmark: pgfId-4155098]Description 
         
  
       
 
       
          
        	[bookmark: pgfId-4261998]Unknown
  
        	[bookmark: pgfId-4155105]gray
  
        	[bookmark: pgfId-4155107]Neither the source nor the destination host is on a network that is monitored by network discovery.
  
       
 
       
          
        	[bookmark: pgfId-4262233]Vulnerable
  
        	[bookmark: pgfId-4262235]red
  
        	[bookmark: pgfId-4262237]Either:
 
          
          	 [bookmark: pgfId-4262238]the source or the destination host is in the network map, and a vulnerability is mapped to the host
 
          	 [bookmark: pgfId-4262239]the source or destination host is potentially compromised by a virus, trojan, or other piece of malicious software; see Setting Impact Level 1 for more information
 
         
  
       
 
       
          
        	[bookmark: pgfId-4262004]Potentially Vulnerable
  
        	[bookmark: pgfId-4155143]orange
  
        	[bookmark: pgfId-4155145]Either the source or the destination host is in the network map and one of the following is true:
 
          
          	 [bookmark: pgfId-4155149]for port-oriented traffic, the port is running a server application protocol
 
          	 [bookmark: pgfId-4155150]for non-port-oriented traffic, the host uses the protocol
 
         
  
       
 
       
          
        	[bookmark: pgfId-4262284]Currently Not Vulnerable
  
        	[bookmark: pgfId-4262286]yellow
  
        	[bookmark: pgfId-4262288]Either the source or the destination host is in the network map and one of the following is true:
 
          
          	 [bookmark: pgfId-4262289]for port-oriented traffic (for example, TCP or UDP), the port is not open
 
          	 [bookmark: pgfId-4262290]for non-port-oriented traffic (for example, ICMP), the host does not use the protocol 
 
         
  
       
 
       
          
        	[bookmark: pgfId-4262158]Unknown Target
  
        	[bookmark: pgfId-4262160]blue
  
        	[bookmark: pgfId-4262162]Either the source or destination host is on a monitored network, but there is no entry for the host in the network map.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-4155189]To use the impact level on the table view to evaluate events:
 
    [bookmark: pgfId-4207306]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-4207307]Step 1 Select Analysis > Intrusions > Events.
 
    [bookmark: pgfId-4207308]The first page of the default intrusion events workflow appears. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
    [bookmark: pgfId-4155205]Step 2 Constrain the event view to view only those events that you want to evaluate.
 
    [bookmark: pgfId-4155209]For more information, see Using Drill-Down and Table View Pages.
 
    [bookmark: pgfId-4155210]Step 3 At the top of the page, click Table View of Events.
 
    [bookmark: pgfId-4155214]The table view of events appears. Impact can have any of the values described in the Impact Levels table.
 
    [bookmark: pgfId-4155225]Step 4 To sort the table by impact level, click Impact. 
 
    [bookmark: pgfId-4155226]The events are sorted by impact level.
 
     
      
    
 
    
 
    [bookmark: pgfId-4155227]Tip To reverse the sort order, click Impact again.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4410084][bookmark: 14092]Reading Preproces[bookmark: marker-4410083]sor Events
 
    [bookmark: pgfId-4410091]License: Protection
 
    [bookmark: pgfId-4410093]Preprocessors provide two functions: performing the specified action on the packet (for example, decoding and normalizing HTTP traffic) and reporting the execution of specified [bookmark: marker-4410094]preprocessor options by generating an event whenever a packet triggers that preprocessor option and the associated preprocessor rule is enabled (for example, you can enable the Double Encoding HTTP Inspect option and the associated preprocessor rule with the HTTP Inspect generator (GID) 119 and the Snort ID (SID) 2 to generate an event when the preprocessor encounters IIS double-encoded traffic). Generating events to report the execution of preprocessors helps you detect anomalous protocol exploits. For example, attackers can craft overlapping IP fragments to cause a DoS attack on a host. The IP defragmentation preprocessor can detect this type of attack and generate an intrusion event for it. 
 
    [bookmark: pgfId-4410095]See the following sections for more information:
 
     
     	 [bookmark: pgfId-4410099]Understanding the Preprocessor Event Packet Display describes the information contained in a preprocessor-generated event.
 
     	 [bookmark: pgfId-4410103]Reading Preprocessor Generator IDs details the information provided by the preprocessor generator ID.
 
    
 
     
      [bookmark: pgfId-4410105]Understanding [bookmark: 35927]the Preprocessor Event Packet Display
 
     [bookmark: pgfId-4410112]License: Protection
 
     [bookmark: pgfId-4410114]Preprocessor events differ from rule events in that the packet display does not include a detailed rule description for the event. Instead, the packet display shows the event message, the generator ID, Snort ID, the packet header data, and the packet payload. This allows you to analyze the packet’s header information, determine if its header options are being used and if they can exploit your system, and inspect the packet payload. After the preprocessors analyze each packet, the rules engine executes appropriate rules against it (if the preprocessor was able to defragment it and establish it as part of a valid session) to further analyze potential content-level threats and report on them.
 
    
 
     
      [bookmark: pgfId-4410117][bookmark: 28550]Reading Prep[bookmark: marker-4410116]rocessor Generator IDs
 
     [bookmark: pgfId-4410124]License: Protection
 
     [bookmark: pgfId-4410126]Each preprocessor has its own Generator ID number, or GID, that indicates which preprocessor was triggered by the packet. Some of the preprocessors also have related SIDs, which are ID numbers that classify potential attacks. This helps you analyze events more effectively by categorizing the type of event much the way a rule’s Snort ID (SID) can offer context for packets triggering rules. You can list preprocessor rules by preprocessor in the Preprocessors filter group on the intrusion policy Rules page; you can also list preprocessor rules in the preprocessor and packet decoder sub-groupings in the Category filter group. See Tuning Intrusion Policies Using Rules and Table 32-1 for more information.
 
      
       
     
 
     
 
     [bookmark: pgfId-4410136]Note Events generated by standard text rules have a generator ID of 1. The event’s SID indicates which specific rule triggered. For shared object rules, the events have a generator ID of 3 and a SID that indicates which specific rule was triggered.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-4452013]Table 41-7 [bookmark: 65555]Generator IDs 
 
        
        
         
         	 
           
           [bookmark: pgfId-4452019]ID 
          
  
         	 
           
           [bookmark: pgfId-4452021]Component 
          
  
         	 
           
           [bookmark: pgfId-4452023]Description 
          
  
         	 
           
           [bookmark: pgfId-4454040]For more information, see... 
          
  
        
 
         
         	[bookmark: pgfId-4452025]1
  
         	[bookmark: pgfId-4452028]Standard[bookmark: marker-4452027] Text Rule
  
         	[bookmark: pgfId-4452033]The event was generated when the packet triggered a standard text rule.
  
         	[bookmark: pgfId-4454042]Table 32-1
  
        
 
         
         	[bookmark: pgfId-4452038]2
  
         	[bookmark: pgfId-4452041]Tagge[bookmark: marker-4452040]d Packets 
  
         	[bookmark: pgfId-4452043]The event was generated by the Tag generator, which generates packets from a tagged session. This occurs when the tag rule option is used..
  
         	[bookmark: pgfId-4454044]Evaluating Post-Attack Traffic
  
        
 
         
         	[bookmark: pgfId-4452048]3
  
         	[bookmark: pgfId-4452051]Shar[bookmark: marker-4452050]ed Object Rule
  
         	[bookmark: pgfId-4452056]The event was generated when the packet triggered a shared object rule.
  
         	[bookmark: pgfId-4454046]Table 32-1
  
        
 
         
         	[bookmark: pgfId-4452061]102
  
         	[bookmark: pgfId-4452064]HTTP De[bookmark: marker-4452063]coder
  
         	[bookmark: pgfId-4452066]The decoder engine decoded HTTP data within the packet. 
  
         	[bookmark: pgfId-4454048]Decoding HTTP Traffic
  
        
 
         
         	[bookmark: pgfId-4452068]105
  
         	[bookmark: pgfId-4452071]Ba[bookmark: marker-4452070]ck Orifice Detector
  
         	[bookmark: pgfId-4452074]The Ba[bookmark: marker-4452073]ck Orifice Detector identified a Back Orifice attack associated with the packet.
  
         	[bookmark: pgfId-4454050]Detecting Back Orifice
  
        
 
         
         	[bookmark: pgfId-4452079]106
  
         	[bookmark: pgfId-4452082]RPC Dec[bookmark: marker-4452081]oder
  
         	[bookmark: pgfId-4452086]The RPC decoder decoded the packet.
  
         	[bookmark: pgfId-4454052]Using the Sun RPC Preprocessor
  
        
 
         
         	[bookmark: pgfId-4452089]116
  
         	[bookmark: pgfId-4452092]Pack[bookmark: marker-4452091]et Decoder
  
         	[bookmark: pgfId-4452096]The event was generated by the packet decoder.
  
         	[bookmark: pgfId-4454054]Understanding Packet Decoding
  
        
 
         
         	[bookmark: pgfId-4452099]119, 120
  
         	[bookmark: pgfId-4452102]HTTP [bookmark: marker-4452101]Inspect Preprocessor
  
         	[bookmark: pgfId-4452104]The event was generated by the HTTP Inspect preprocessor. GID 120 rules relate to server-specific HTTP traffic.
  
         	[bookmark: pgfId-4454056]Decoding HTTP Traffic
  
        
 
         
         	[bookmark: pgfId-4452109]122
  
         	[bookmark: pgfId-4452112]Portscan[bookmark: marker-4452111] Detector
  
         	[bookmark: pgfId-4452116]The event was generated by the portscan flow detector. See for more information
  
         	[bookmark: pgfId-4454058]Detecting Portscans
  
        
 
         
         	[bookmark: pgfId-4452119]123
  
         	[bookmark: pgfId-4452122]IP Defra[bookmark: marker-4452121]gmentor
  
         	[bookmark: pgfId-4452124]The event was generated when a fragmented IP datagram could not be properly reassembled.
  
         	[bookmark: pgfId-4454060]Defragmenting IP Packets
  
        
 
         
         	[bookmark: pgfId-4452129]124
  
         	[bookmark: pgfId-4452132][bookmark: marker-4452131]SMTP Decoder
  
         	[bookmark: pgfId-4452134]The event was generated when the SMTP preprocessor detected an exploit against an SMTP verb.
  
         	[bookmark: pgfId-4454062]Understanding SMTP Decoding
  
        
 
         
         	[bookmark: pgfId-4452139]125
  
         	[bookmark: pgfId-4452142][bookmark: marker-4452141]FTP Decoder
  
         	[bookmark: pgfId-4452144]The event was generated when the FTP/Telnet decoder detected an exploit within FTP traffic.
  
         	[bookmark: pgfId-4454064]Understanding Server-Level FTP Options
 [bookmark: pgfId-4455033]Understanding Client-Level FTP Options
  
        
 
         
         	[bookmark: pgfId-4452152]126
  
         	[bookmark: pgfId-4452155][bookmark: marker-4452154]Telnet Decoder
  
         	[bookmark: pgfId-4452157]The event was generated when the FTP/Telnet decoder detected an exploit within telnet traffic.
  
         	[bookmark: pgfId-4454066]Decoding FTP and Telnet Traffic
  
        
 
         
         	[bookmark: pgfId-4452162]128
  
         	[bookmark: pgfId-4452165]SSH Pr[bookmark: marker-4452164]eprocessor
  
         	[bookmark: pgfId-4452167]The event was generated when the SSH preprocessor detected an exploit within SSH traffic.
  
         	[bookmark: pgfId-4454068]Detecting Exploits Using the SSH Preprocessor
  
        
 
         
         	[bookmark: pgfId-4452172]129
  
         	[bookmark: pgfId-4452176]Stream Pre[bookmark: marker-4452174]proces[bookmark: marker-4452175]sor
  
         	[bookmark: pgfId-4452178]The event was generated during stream preprocessing by the stream preprocessor.
  
         	[bookmark: pgfId-4454070]Using TCP Stream Preprocessing
  
        
 
         
         	[bookmark: pgfId-4452183]131
  
         	[bookmark: pgfId-4452186]DNS Prepr[bookmark: marker-4452185]ocessor
  
         	[bookmark: pgfId-4452190]The event was generated by the DNS preprocessor.
  
         	[bookmark: pgfId-4454072]Detecting Exploits in DNS Name Server Responses
  
        
 
         
         	[bookmark: pgfId-4452193]133
  
         	[bookmark: pgfId-4452196][bookmark: marker-4452195]DCE/RPC Preprocessor
  
         	[bookmark: pgfId-4452200]The event was generated by the DCE/RPC preprocessor.
  
         	[bookmark: pgfId-4454074]Decoding DCE/RPC Traffic
  
        
 
         
         	[bookmark: pgfId-4452203]134
  
         	[bookmark: pgfId-4452206]Rul[bookmark: marker-4452205]e Latency
 [bookmark: pgfId-4452207]Packet Latency
  
         	[bookmark: pgfId-4452209]The event was generated when rule latency suspended (134:1) or re-enabled (134:2) a group of intrusion rules, or when the system stopped inspecting a packet because the packet latency threshold was exceeded (134:3). 
  
         	[bookmark: pgfId-4454076]Configuring Packet and Intrusion Rule Latency Thresholds
  
        
 
         
         	[bookmark: pgfId-4452220]135
  
         	[bookmark: pgfId-4452222]Rate-Based Attack Detector
  
         	[bookmark: pgfId-4452224]The event was generated when a rate-based attack detector identified excessive connections to hosts on the network.
  
         	[bookmark: pgfId-4454078]Preventing Rate-Based Attacks
  
        
 
         
         	[bookmark: pgfId-4452229]138, 139
  
         	[bookmark: pgfId-4452232]Sens[bookmark: marker-4452231]itive Data Preprocessor
  
         	[bookmark: pgfId-4452236]The event was generated by the sensitive data preprocessor.
  
         	[bookmark: pgfId-4454080]Detecting Sensitive Data
  
        
 
         
         	[bookmark: pgfId-4452239]140
  
         	[bookmark: pgfId-4452242]SIP Prepr[bookmark: marker-4452241]ocessor
  
         	[bookmark: pgfId-4452246]The event was generated by the SIP preprocessor.
  
         	[bookmark: pgfId-4454082]Decoding the Session Initiation Protocol
  
        
 
         
         	[bookmark: pgfId-4452249]141
  
         	[bookmark: pgfId-4452252]IMAP Prepr[bookmark: marker-4452251]ocessor
  
         	[bookmark: pgfId-4452256]The event was generated by the IMAP preprocessor.
  
         	[bookmark: pgfId-4454084]Decoding IMAP Traffic
  
        
 
         
         	[bookmark: pgfId-4452259]142
  
         	[bookmark: pgfId-4452262]POP Prepr[bookmark: marker-4452261]ocessor
  
         	[bookmark: pgfId-4452266]The event was generated by the POP preprocessor.
  
         	[bookmark: pgfId-4454086]Decoding POP Traffic
  
        
 
         
         	[bookmark: pgfId-4452269]143
  
         	[bookmark: pgfId-4452272]GTP Prepr[bookmark: marker-4452271]ocessor
  
         	[bookmark: pgfId-4452276]The event was generated by the GTP preprocessor.
  
         	[bookmark: pgfId-4454088]Configuring the GTP Command Channel
  
        
 
         
         	[bookmark: pgfId-4452279]144
  
         	[bookmark: pgfId-4452282]Modbus Prepr[bookmark: marker-4452281]ocessor
  
         	[bookmark: pgfId-4452286]The event was generated by the Modbus SCADA preprocessor.
  
         	[bookmark: pgfId-4454090]Configuring the Modbus Preprocessor
  
        
 
         
         	[bookmark: pgfId-4452289]145
  
         	[bookmark: pgfId-4452292]DNP3 Prepr[bookmark: marker-4452291]ocessor
  
         	[bookmark: pgfId-4452296]The event was generated by the DNP3 SCADA preprocessor.
  
         	[bookmark: pgfId-4454092]Configuring the DNP3 Preprocessor
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4394614][bookmark: 76043]Search[bookmark: marker-4394612]ing for Intrusion Events
 
    [bookmark: pgfId-4183881]License: Protection
 
    [bookmark: pgfId-4355602]You can search for specific intrusion events by using a predefined search delivered with the FireSIGHT System or by creating your own search criteria.
 
    [bookmark: pgfId-2834009]The predefined searches serve as examples and can provide quick access to important information about your network. You may want to modify specific fields within the default searches to customize them for your network environment, then save them to reuse later. Keep in mind that your search results depend on the available data in the events you are searching. In other words, depending on the available data, your search constraints may not apply. For example, only intrusion events triggered on decrypted traffic contain SSL information.
 
     
      
    
 
    
 
    [bookmark: pgfId-2324639]Tip For information about the syntax for specifying IP addresses and ports in an intrusion event search, see Specifying IP Addresses in Searches and Specifying Ports in Searches.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4209704]For more information on searching, including how to load and delete saved searches, see Searching for Events.
 
    [bookmark: pgfId-4488002]The search criteria you can use are described in the following list:
 
    [bookmark: pgfId-3617330]Priority
 
    [bookmark: pgfId-3617332]Specify the priority of the events you want to view. The priority corresponds to either the value of the priority keyword or the value for the classtype keyword. For other intrusion events, the priority is determined by the decoder or preprocessor. Valid values are high, medium, and low. 
 
    [bookmark: pgfId-4192688]Impact
 
    [bookmark: pgfId-4192689]Specify the impact level assigned to the intrusion event based on the correlation between intrusion data and network discovery data. Valid case-insensitive values are Impact 0, Impact Level 0, Impact 1, Impact Level 1, Impact 2, Impact Level 2, Impact 3, Impact Level 3, Impact 4, and Impact Level 4.
 
    [bookmark: pgfId-4262452]Do not use impact icon colors or partial strings (for example, do not use blue, level 1, or 0).
 
    [bookmark: pgfId-4192692]For more information, see Using Impact Levels to Evaluate Events.
 
    [bookmark: pgfId-4192753]Inline Result
 
    [bookmark: pgfId-4192754]Type either:
 
    [bookmark: pgfId-4192755] – dropped, to specify whether the packet is dropped in an inline deployment
 
    [bookmark: pgfId-4192756] – would have dropped, to specify whether the packet would have dropped if the intrusion policy had been set to drop packets in an inline deployment
 
    [bookmark: pgfId-4217670]Note that the system does not drop packets in a passive deployment, including when an inline interface is in tap mode, regardless of the rule state or the inline drop behavior of the intrusion policy.
 
    [bookmark: pgfId-4217969]Source IP
 
    [bookmark: pgfId-4283175]Specify the IP address used by the source host involved in the intrusion events.
 
    [bookmark: pgfId-4283179]Destination IP
 
    [bookmark: pgfId-4268431]Specify the IP address used by the destination host involved in the intrusion events.
 
    [bookmark: pgfId-4217973]Source/Destination IP
 
    [bookmark: pgfId-4283192]Specify the source or destination IP address used by the host whose intrusion events you want to view.
 
    [bookmark: pgfId-4325853]Source Country
 
    [bookmark: pgfId-4325869]Specify the country of the source host involved in the intrusion events.
 
    [bookmark: pgfId-4325954]Destination Country
 
    [bookmark: pgfId-4325975]Specify the country of the destination host involved in the intrusion events.
 
    [bookmark: pgfId-4326053]Source/Destination Country
 
    [bookmark: pgfId-4326081]Specify the country of the source or destination host involved in the intrusion events you want to view.
 
    [bookmark: pgfId-4326202]Source Continent
 
    [bookmark: pgfId-4326245]Specify the continent of the source host involved in the intrusion events.
 
    [bookmark: pgfId-4326269]Destination Continent
 
    [bookmark: pgfId-4326292]Specify the continent of the destination host involved in the intrusion events.
 
    [bookmark: pgfId-4326370]Source/Destination Continent
 
    [bookmark: pgfId-4326400]Specify the continent of the source or destination host involved in the intrusion events you want to view.
 
    [bookmark: pgfId-4283197]Origin[bookmark: marker-4283196]al Client IP
 
    [bookmark: pgfId-4217976]Specify the original client IP address extracted from the X-Forwarded-For (XFF), True-Client-IP, or custom-defined HTTP headers. To extract a value for this field in an intrusion event, you must enable the HTTP preprocessor Extract Original Client IP Address option. Optionally, in the same area of the network analysis policy, you can also specify up to six custom client IP headers, as well as set the priority order in which the system selects the value for the Original Client IP event field. See Selecting Server-Level HTTP Normalization Options for more information.
 
    [bookmark: pgfId-4218065]Protocol
 
    [bookmark: pgfId-4221429]Type the name or number of the transport protocol used in the connection as listed in http://www.iana.org/assignments/protocol-numbers.
 
    [bookmark: pgfId-4221450]Note that there is no Protocol column in the intrusion event table view. This is the protocol associated with the source and destination port/ICMP column.
 
    [bookmark: pgfId-4218069]Source Port / ICMP Type
 
    [bookmark: pgfId-4218070]Specify the source port associated with the intrusion event.
 
     
      
    
 
    
 
    [bookmark: pgfId-4218071]Tip For ICMP traffic, which does not target ports, you can use this field to search for events with specific ICMP types.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4218072]Destination Port / ICMP Code
 
    [bookmark: pgfId-4218073]Specify the destination port associated with the intrusion event.
 
     
      
    
 
    
 
    [bookmark: pgfId-4218074]Tip For ICMP traffic, which does not target ports, you can use this field to search for events with specific ICMP codes.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4218379]VLAN ID
 
    [bookmark: pgfId-4218380]Specify the innermost VLAN ID associated with the packet that triggered the intrusion event.
 
    [bookmark: pgfId-4245896]MPLS Label
 
    [bookmark: pgfId-4245909]Specify the Multiprotocol Label Switching label of the packet associated with the packet that triggered the intrusion event.
 
    [bookmark: pgfId-4218381]Message
 
    [bookmark: pgfId-4218382]Specify all or part of the event message for the events you want to view.
 
    [bookmark: pgfId-4218383]Classification
 
    [bookmark: pgfId-4218384]Enter the classification number, or all or part of the classification name or description for the rule that generated the events you want to view. You can also enter a comma-separated list of numbers, names, or descriptions. Finally, if you add a custom classification, you can also search using all or part of its name or description. See the Rule Classifications table for a list of classification numbers, names, and descriptions.
 
    [bookmark: pgfId-4218388]Generator
 
    [bookmark: pgfId-4218389]Specify the component that generated the events you want to view, as listed in Table 41-7.
 
    [bookmark: pgfId-4218393]Snort ID
 
     
      
       
       [bookmark: pgfId-4266895]Table 41-8 [bookmark: 99337]Snort ID Search Values 
 
       
       
        
        	 
          
          [bookmark: pgfId-4266899]Value 
         
  
        	 
          
          [bookmark: pgfId-4266901]Example 
         
  
       
 
        
        	[bookmark: pgfId-4266903]a single SID
  
        	[bookmark: pgfId-4266905]10000
  
       
 
        
        	[bookmark: pgfId-4267367]a SID range
  
        	[bookmark: pgfId-4267369]10000-11000
  
       
 
        
        	[bookmark: pgfId-4267371]greater than a SID
  
        	[bookmark: pgfId-4267373]>10000
  
       
 
        
        	[bookmark: pgfId-4267375]greater than or equal to a SID
  
        	[bookmark: pgfId-4267377]>=10000
  
       
 
        
        	[bookmark: pgfId-4267379]less than a SID
  
        	[bookmark: pgfId-4267381]<10000
  
       
 
        
        	[bookmark: pgfId-4267383]less than or equal to a SID
  
        	[bookmark: pgfId-4267385]<=10000
  
       
 
        
        	[bookmark: pgfId-4267395]a comma-separated list of SIDs
  
        	[bookmark: pgfId-4267397]10000,11000,12000
  
       
 
        
        	[bookmark: pgfId-4266907]a single GID:SID combination
  
        	[bookmark: pgfId-4266909]1:10000
  
       
 
        
        	[bookmark: pgfId-4266971]a comma-separated list of GID:SID combinations
  
        	[bookmark: pgfId-4266973]1:10000,1:11000,1:12000
  
       
 
        
        	[bookmark: pgfId-4266967]a comma-separated list of SIDs and GID:SID combinations
  
        	[bookmark: pgfId-4266969]10000,1:11000,12000
  
       
 
       
     
 
    
 
    [bookmark: pgfId-4266582]For more information, see Reading Preprocessor Generator IDs.
 
    [bookmark: pgfId-4218398]Note that the Snort ID column does not appear in search results; the SID of the events you are viewing is listed in the Message column.
 
    [bookmark: pgfId-4218399]Source User
 
    [bookmark: pgfId-4218400]Specify the User ID for a user logged in to the source host.
 
    [bookmark: pgfId-4218401]Destination User
 
    [bookmark: pgfId-4218402]Specify the User ID for a user logged in to the destination host.
 
    [bookmark: pgfId-4218403]Source/Destination User
 
    [bookmark: pgfId-4220191]Specify the User ID for a user logged in to the source or destination host.
 
    [bookmark: pgfId-4220234]Application Protocol
 
    [bookmark: pgfId-4220235]Type the name of the application protocol, which represents communications between hosts, detected in the traffic that triggered the intrusion event.
 
    [bookmark: pgfId-4220321]Client
 
    [bookmark: pgfId-4220240]Type the name of the client application, which represents software running on the monitored host detected in the traffic that triggered the intrusion event.
 
    [bookmark: pgfId-4220241]Web Application
 
    [bookmark: pgfId-4220223]Type the name of the web application, which represents the content or requested URL for HTTP traffic detected in the traffic that triggered the intrusion event.
 
    [bookmark: pgfId-4220192]Category, Tag (Application Protocol, Client, Web Application)
 
    [bookmark: pgfId-4220193]Type a category or tag associated with the application detected in the session. Use a commas to separate multiple categories or tags. These fields are case-insensitive.
 
    [bookmark: pgfId-4219297]Application Risk
 
    [bookmark: pgfId-4219298]Type the highest risk associated with the application detected in the session. Valid criteria are: Very High, High, Medium, Low, and Very Low. These fields are case-insensitive.
 
    [bookmark: pgfId-4219300]Business Relevance
 
    [bookmark: pgfId-4219395]Type the lowest business relevance associated with an application detected in the session. Valid criteria are: Very High, High, Medium, Low, and Very Low. These fields are case-insensitive.
 
    [bookmark: pgfId-4218923]Security Zone (Ingress, Egress, Ingress/Egress)
 
    [bookmark: pgfId-4218924]Type the name of a security zone associated with the packet that triggered the event. These fields are case-insensitive. See Working with Security Zones. 
 
    [bookmark: pgfId-4218501]Device
 
    [bookmark: pgfId-4358457]Type the device name or IP address, or a device group, stack, or cluster name to restrict the search to specific devices where the access control policy was applied. For detailed information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
    [bookmark: pgfId-4358468]Note that the primary and secondary devices in a stacked configuration report intrusion events separately. See Managing Stacked Devices for more information.
 
    [bookmark: pgfId-4358469]Security Context
 
    [bookmark: pgfId-4375511]Type the name of the security context identifying the virtual firewall group through which the traffic passed. Note that the system only populates this field for ASA FirePOWER devices in multiple context mode.
 
    [bookmark: pgfId-4375515]Interface (Ingress, Egress)
 
    [bookmark: pgfId-4218566]Type the name of an interface associated with the packet that triggered the event; see Configuring Sensing Interfaces.
 
    [bookmark: pgfId-4218842]Intrusion Policy
 
    [bookmark: pgfId-4218843]Type the name of the intrusion policy associated with the event; see Managing Intrusion Policies.
 
    [bookmark: pgfId-4218634]Access Control Policy
 
    [bookmark: pgfId-4218635]Type the name of the access control policy associated with the event; see Managing Access Control Policies.
 
    [bookmark: pgfId-4218639]Access Control Rule
 
    [bookmark: pgfId-4218640]Type the name of the access control rule associated with the event; see Tuning Traffic Flow Using Access Control Rules.
 
    [bookmark: pgfId-4218728]HTTP Hostname
 
    [bookmark: pgfId-4218729]Specify a single host name that was extracted from the HTTP request Host header.
 
    [bookmark: pgfId-4218730]To associate host names with intrusion events for HTTP client traffic, you must enable the HTTP Inspect preprocessor Log Hostname option. See Selecting Server-Level HTTP Normalization Options for more information.
 
    [bookmark: pgfId-4218734]HTTP URI
 
    [bookmark: pgfId-4218735]Specify a single URI associated with the HTTP request packet that triggered the intrusion event.
 
    [bookmark: pgfId-4218736]To associate URIs with intrusion events for HTTP traffic, you must enable the HTTP Inspect preprocessor Log URI option. See Selecting Server-Level HTTP Normalization Options for more information.
 
    [bookmark: pgfId-4218740]Email Sender
 
    [bookmark: pgfId-4218741]Specify the address of the email sender that was extracted from the SMTP MAIL FROM command. You can also enter a comma-separated list to search for events associated with all specified addresses. See Understanding Intrusion Events for more information.
 
    [bookmark: pgfId-4218745]Email Recipient
 
    [bookmark: pgfId-4218746]Specify the address of the email recipient that was extracted from the SMTP RCPT TO command. You can also enter a comma-separated list to search for events associated with all specified addresses. See Understanding Intrusion Events for more information.
 
    [bookmark: pgfId-4218750]Email Attachments
 
    [bookmark: pgfId-4218751]Specify the MIME attachment file name that was extracted from the MIME Content-Disposition header. Enter a comma-separated list to search for events associated with all attachment file names in the list. See Understanding Intrusion Events for more information.
 
    [bookmark: pgfId-4218755]Email Headers
 
    [bookmark: pgfId-4218756]Specify data that was extracted from the email header. Note that email headers do not appear in the table view of intrusion events, but you can use email header data as a search criterion.
 
    [bookmark: pgfId-4218757]To associate email headers with intrusion events for SMTP traffic, you must enable the SMTP preprocessor Log Headers option. See Understanding SMTP Decoding for more information.
 
    [bookmark: pgfId-4218761]Reviewed By
 
    [bookmark: pgfId-4218764]Specify the name of the user who reviewed the event. See Reviewing Intrusion Events.
 
     
      
    
 
    
 
    [bookmark: pgfId-4457446]Tip You can enter unreviewed to search for events that have not been reviewed.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4459962][bookmark: 87732]Special Search Syntax for Intrusion Events
 
    [bookmark: pgfId-4460027]To supplement the general search syntax listed above, the following list describes some special search syntax for intrusion events.
 
    [bookmark: pgfId-4465032]The SSL Actual Action taken
 
    [bookmark: pgfId-4465033]Type any of the following keywords to view intrusion events for encrypted traffic to which the system applied the action specified:
 
    [bookmark: pgfId-4465034] – Do Not Decrypt represents connections the system did not decrypt.
 
    [bookmark: pgfId-4465035] – Block and Block with Reset represent blocked encrypted connections.
 
    [bookmark: pgfId-4465036] – Decrypt (Known Key) represents incoming connections decrypted using a known private key.
 
    [bookmark: pgfId-4465037] – Decrypt (Replace Key) represents outgoing connections decrypted using a self-signed server certificate with a substituted public key.
 
    [bookmark: pgfId-4465038] – Decrypt (Resign) represents outgoing connections decrypted using a re-signed server certificate.
 
    [bookmark: pgfId-4465039]This column does not appear in the intrusion events table view.
 
    [bookmark: pgfId-4465040]The SSL Failure Reason
 
    [bookmark: pgfId-4465041]Type any of the following keywords to view intrusion events for encrypted traffic that the system failed to decrypt for the reason specified: 
 
    [bookmark: pgfId-4465042] – Unknown
 
    [bookmark: pgfId-4465043] – No Match
 
    [bookmark: pgfId-4465044] – Success
 
    [bookmark: pgfId-4465045] – Uncached Session
 
    [bookmark: pgfId-4465046] – Unknown Cipher Suite
 
    [bookmark: pgfId-4465047] – Unsupported Cipher Suite
 
    [bookmark: pgfId-4465048] – Unsupported SSL Version
 
    [bookmark: pgfId-4465049] – SSL Compression Used
 
    [bookmark: pgfId-4465050] – Session Undecryptable in Passive Mode
 
    [bookmark: pgfId-4465051] – Handshake Error
 
    [bookmark: pgfId-4465052] – Decryption Error
 
    [bookmark: pgfId-4465053] – Pending Server Name Category Lookup
 
    [bookmark: pgfId-4465054] – Pending Common Name Category Lookup
 
    [bookmark: pgfId-4465055] – Internal Error
 
    [bookmark: pgfId-4465056] – Network Parameters Unavailable
 
    [bookmark: pgfId-4465057] – Invalid Server Certificate Handle
 
    [bookmark: pgfId-4465058] – Server Certificate Fingerprint Unavailable
 
    [bookmark: pgfId-4465059] – Cannot Cache Subject DN
 
    [bookmark: pgfId-4465060] – Cannot Cache Issuer DN
 
    [bookmark: pgfId-4465061] – Unknown SSL Version
 
    [bookmark: pgfId-4465062] – External Certificate List Unavailable
 
    [bookmark: pgfId-4465063] – External Certificate Fingerprint Unavailable
 
    [bookmark: pgfId-4465064] – Internal Certificate List Invalid
 
    [bookmark: pgfId-4465065] – Internal Certificate List Unavailable
 
    [bookmark: pgfId-4465066] – Internal Certificate Unavailable
 
    [bookmark: pgfId-4465067] – Internal Certificate Fingerprint Unavailable
 
    [bookmark: pgfId-4465068] – Server Certificate Validation Unavailable
 
    [bookmark: pgfId-4465069] – Server Certificate Validation Failure
 
    [bookmark: pgfId-4465070] – Invalid Action
 
    [bookmark: pgfId-4465071]This column does not appear in the intrusion events table view.
 
    [bookmark: pgfId-4465072]The SSL Subject Country
 
    [bookmark: pgfId-4465073]Type a two-character ISO 3166-1 alpha-2 country code to view intrusion events for encrypted traffic associated with the country of a certificate subject. 
 
    [bookmark: pgfId-4465074]This column does not appear in the intrusion events table view.
 
    [bookmark: pgfId-4465075]The SSL Issuer Country
 
    [bookmark: pgfId-4465076]Type a two-character ISO 3166-1 alpha-2 country code to view intrusion events for encrypted traffic associated with the country of a certificate issuer. 
 
    [bookmark: pgfId-4465077]This column does not appear in the intrusion events table view.
 
    [bookmark: pgfId-4465078]SSL Certificate Fingerprint
 
    [bookmark: pgfId-4465079]Type or paste the SHA hash value used to authenticate a certificate to view intrusion events for traffic associated with that certificate.
 
    [bookmark: pgfId-4465782]This column does not appear in the intrusion events table view.
 
    [bookmark: pgfId-4465080]SSL Public Key Fingerprint 
 
    [bookmark: pgfId-4465081]Type or paste the SHA hash value used to authenticate the public key contained within a certificate to view intrusion events for traffic associated with that certificate.
 
    [bookmark: pgfId-4465799]This column does not appear in the intrusion events table view.
 
    [bookmark: pgfId-4459740]To search for intrusion events:
 
    [bookmark: pgfId-4457451]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-4444155]Step 1 Select Analysis > Search.
 
    [bookmark: pgfId-4444156]The Intrusion Events search page appears.
 
    [bookmark: pgfId-4444157]You can also click Search while viewing lists of intrusion events (Analysis > Intrusions > Events).
 
    [bookmark: pgfId-4444160]Step 2 Enter your search criteria in the appropriate fields, as described in the list above the procedure.
 
     
      
      	 [bookmark: pgfId-4444163]For more information on search syntax, including using objects in searches, see Searching for Events.
 
      	 [bookmark: pgfId-4450162]See Viewing the Certificate Associated with an Encrypted Connection for fields related to public key certificates.
 
      	 [bookmark: pgfId-4450169]See Special Search Syntax for Intrusion Events for special search syntax for intrusion events.
 
     
 
    
 
    [bookmark: pgfId-4444165]Step 3 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
     
      
    
 
    
 
    [bookmark: pgfId-4444166]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4444167]Step 4 Optionally, you can save the search to be used again in the future. You have the following options:
 
     
      
      	 [bookmark: pgfId-4466004]Click  Save to save the search criteria.
 
     
 
    
 
    [bookmark: pgfId-4466005]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     
      
      	 [bookmark: pgfId-4466006]Click  Save as New  to save a new search or assign a name to a search you created by altering a previously-saved search. 
 
     
 
    
 
    [bookmark: pgfId-4466007]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
    [bookmark: pgfId-4444168]Step 5 Click Search to start the search.
 
    [bookmark: pgfId-4444169]Your search results appear in the default intrusion events workflow, constrained by the current time range. For information on specifying a different default workflow, see Configuring Event View Settings.
 
    [bookmark: pgfId-4373625]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4155739][bookmark: 12737]Using the[bookmark: marker-4155737] Clipboard
 
    [bookmark: pgfId-4183913]License: Protection
 
    [bookmark: pgfId-4155755]The clipboard is a holding area where you can copy intrusion events from any of the intrusion event views. For information on how to add events to the clipboard, see Using Drill-Down and Table View Pages and Using the Packet View.
 
    [bookmark: pgfId-4155762]The contents of the clipboard are sorted by the date and time that the events were generated. After you add intrusion events to the clipboard, you can delete them from the clipboard as well as generate reports on the contents of the clipboard.
 
    [bookmark: pgfId-4155763]You can also add intrusion events from the clipboard to incidents, which are compilations of events that you suspect are involved in a possible violation of your security policies. For more information about adding events from the clipboard to an incident, see Creating an Incident.
 
    [bookmark: pgfId-4155767]See the following sections for more information:
 
     
     	 [bookmark: pgfId-4155771]Generating Clipboard Reports
 
     	 [bookmark: pgfId-4155775]Deleting Events from the Clipboard
 
    
 
     
      [bookmark: pgfId-4155778][bookmark: 52364]Generating Clipboard[bookmark: marker-4155777] Reports
 
     [bookmark: pgfId-4183929]License: Protection
 
     [bookmark: pgfId-4155793]You can generate a report for the events on the clipboard just as you would from any of the event views.
 
     [bookmark: pgfId-4155794]To generate a report on intrusion events from the clipboard:
 
     [bookmark: pgfId-4198104]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4155799]Step 1 Add one or more events to the clipboard:
 
      
       
       	 [bookmark: pgfId-4155800]For information on how to add events to the clipboard from a drill-down page or table view of events, see Using Drill-Down and Table View Pages.
 
       	 [bookmark: pgfId-4155806]For information on how to add events to the clipboard from the packet view, see Using the Packet View.
 
      
 
     
 
     [bookmark: pgfId-4155811]Step 2 Select Analysis > Intrusions > Clipboard.
 
     [bookmark: pgfId-4155812]The clipboard appears. 
 
     [bookmark: pgfId-4155817]Step 3 You have the following options:
 
      
       
       	 [bookmark: pgfId-4155818]To include specific events from a page on the clipboard, navigate to that page, select the check box next to the events, and click  Generate Report .
 
       	 [bookmark: pgfId-4155819]To include all the events from the clipboard, click  Generate Report All .
 
      
 
     
 
     [bookmark: pgfId-4155820]In either case, the Report Templates page appears.
 
     [bookmark: pgfId-4155825]Step 4 Specify how you want your report to look, then click Generate.
 
     [bookmark: pgfId-4234064]The Generate Report pop-up dialog appears.
 
     [bookmark: pgfId-4234077]Step 5 Select one or more output formats (HTML, PDF, CSV) and, optionally, modify any of the other settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-4155828]Tip For more information about using the Report Designer, see Working with Reports.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4155830]Step 6 Click Generate, then click Yes.
 
     [bookmark: pgfId-4234104]The Report Generation Complete pop-up window appears with a link to view your report.
 
     [bookmark: pgfId-4234109]Step 7 Click either:
 
      
       
       	 [bookmark: pgfId-4234110]a report link, which opens a new window to display the report you selected.
 
       	 [bookmark: pgfId-4234111] OK to return to the Report Templates page where you can modify your report design.
 
      
 
     
 
     [bookmark: pgfId-4373631]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4155836][bookmark: 43495]Deleting Events from[bookmark: marker-4155835] the Clipboard
 
     [bookmark: pgfId-4183945]License: Protection
 
     [bookmark: pgfId-4155851]If you have intrusion events on the clipboard that you do not want to add to an incident, you can delete the events.
 
      
       
     
 
     
 
     [bookmark: pgfId-4155852]Note Deleting an event from the clipboard does not delete the event from the event database. However, deleting an event from the event database does delete the event from the clipboard.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4155853]To delete events from the clipboard:
 
     [bookmark: pgfId-4198127]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-4155861]Step 1 Select Analysis > Intrusions > Clipboard.
 
     [bookmark: pgfId-4155862]The clipboard appears.
 
     [bookmark: pgfId-4155863]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-4155864]To delete specific intrusion events from a page on the clipboard, navigate to the page, select the check box next to the events, and click  Delete .
 
      
 
     
 
     [bookmark: pgfId-4155865]The events are deleted.
 
      
       
       	 [bookmark: pgfId-4155866]To delete all the intrusion events from the clipboard, click  Delete All .
 
      
 
     
 
     [bookmark: pgfId-4155867]All the events are deleted from the clipboard. Note that if you select the Confirm 'All' Actions option in the Event Preferences, you are first prompted to confirm that you want to delete all the events.
 
     [bookmark: pgfId-4373644]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1164863]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1096272][bookmark: 93025]Handlin[bookmark: marker-1364185]g Incidents 
      
      
 
     
 
 
    [bookmark: pgfId-1414851]Incident handling refers to the response an organization takes when a violation of its security policies is suspected. The FireSIGHT System includes features to support you as you collect and process information that is relevant to your investigation of an incident. You can use these features to gather intrusion events and packet data that may be related to the incident. You can also use the incident as a repository for notes about any activity that you take outside of the FireSIGHT System to mitigate the effects of the attack. For example, if your security policies require that you quarantine compromised hosts from your network, you can note that in the incident. 
 
    [bookmark: pgfId-1346109]The FireSIGHT System also supports an incident life cycle, allowing you to change an incident’s status as you progress through your response to an attack. When you close an incident, you can note any changes you have made to your security policies as a result of any lessons learned.
 
    [bookmark: pgfId-1346121]See the following sections for more information about handling incidents in the FireSIGHT System:
 
     
     	 [bookmark: pgfId-1346125]Incident Handling Basics
 
     	 [bookmark: pgfId-1346130]Creating an Incident
 
     	 [bookmark: pgfId-1346131]Editing an Incident
 
     	 [bookmark: pgfId-1346132]Generating Incident Reports
 
     	 [bookmark: pgfId-1346133]Creating Custom Incident Types
 
    
 
   
 
    
     [bookmark: pgfId-1346137][bookmark: 15641]Incident Handlin[bookmark: marker-1364186]g Basics
 
    [bookmark: pgfId-1515492]License: Protection
 
    [bookmark: pgfId-1346142]Each organization is likely to have its own process for discovering, defining, and responding to violations of its security policies. The sections that follow describe some of the basics of incident handling and how you can incorporate the FireSIGHT System in your incident response plan:
 
     
     	 [bookmark: pgfId-1346204]Definition of an Incident
 
     	 [bookmark: pgfId-1346224]Common Incident Handling Processes
 
     	 [bookmark: pgfId-1346233]Incident Types in the FireSIGHT System
 
    
 
     
      [bookmark: pgfId-1346172][bookmark: 12994]Definition of a[bookmark: marker-1364187]n Incident
 
     [bookmark: pgfId-1515578]License: Protection
 
     [bookmark: pgfId-1346979]Generally, an incident is defined as one or more intrusion events that you suspect are involved in a possible violation of your security policies. Cisco also uses the term to describe the feature you use in the FireSIGHT System to track your response to an incident.
 
     [bookmark: pgfId-1346952]As explained in Working with Intrusion Events, some intrusion events are more important than others to the availability, confidentiality, and integrity of your network assets. For example, the port scan detection features provided by the FireSIGHT System can keep you informed of port scanning activity on your network. Your security policy, however, may not specifically prohibit port scanning or see it as a high priority threat, so rather than take any direct action, you may instead want to keep logs of any port scanning for later forensic study.
 
     [bookmark: pgfId-1434713]On the other hand, if the system generates events that indicate hosts within your network have been compromised and are participating in distributed denial-of-service (DDoS) attacks, then this activity is likely a clear violation of your security policy, and you should create an incident in the FireSIGHT System to help you track your investigation of these events.
 
    
 
     
      [bookmark: pgfId-1347012][bookmark: 67759]Common Incident H[bookmark: marker-1364188]andling Processes
 
     [bookmark: pgfId-1515594]License: Protection
 
     [bookmark: pgfId-1347013]Each organization is likely to define its own process for handling security incidents. Most methodologies include some or all of the following phases:
 
      
      	 [bookmark: pgfId-1349040]Preparation
 
      	 [bookmark: pgfId-1349050]Detection and Notification
 
      	 [bookmark: pgfId-1349058]Investigation and Qualification
 
      	 [bookmark: pgfId-1349063]Communication
 
      	 [bookmark: pgfId-1349068]Containment and Recovery
 
      	 [bookmark: pgfId-1349073]Lessons Learned
 
     
 
     [bookmark: pgfId-1349042]Each of these phases is described in the sections that follow. The descriptions also explain how the FireSIGHT System fits into each phase.
 
     [bookmark: pgfId-1347949][bookmark: 15095]Preparation
 
     [bookmark: pgfId-1347998]You can prepare for incidents in two ways: 
 
      
      	 [bookmark: pgfId-1347999]by having clear and comprehensive security policies in place, as well as the hardware and software resources to enforce them
 
      	 [bookmark: pgfId-1348000]by having a clearly defined plan to respond to incidents and a properly trained team that can implement the plan
 
     
 
     [bookmark: pgfId-1348001]A key part of incident handling is understanding which parts of your network are at the greatest risk. By deploying FireSIGHT System components on those network segments, you can increase your awareness of when and how incidents occur. Also, by taking the time to carefully tune the intrusion policy for each managed device, you can ensure that the events that are generated are of the highest quality.
 
     [bookmark: pgfId-1347984][bookmark: 67271]Detection and Notification
 
     [bookmark: pgfId-1348071]You cannot respond to an incident unless you can detect it. Your incident handling process should note the kinds of security-related events that you can detect and the mechanisms, both software and hardware, that you use to detect them. You should also note where you can detect violations of your security policies. If your network includes segments that are not actively or passively monitored, then you need to note that as well.
 
     [bookmark: pgfId-1348454]The managed devices that you deploy on your network are responsible for analyzing the traffic on the segments where they are installed, for detecting intrusions, and for generating events that describe them. Keep in mind that the access control policy you apply to each of the managed devices governs what kinds of activity they detect and how it is prioritized. You can also set notification options for certain types of intrusion events so that the incident team does not need to sift through hundreds of events. You can specify that you are notified automatically when certain high priority, high severity events are detected.
 
     [bookmark: pgfId-1348565][bookmark: 80804]Investigation and Qualification
 
     [bookmark: pgfId-1348566]Your incident handling process should specify how, after a security incident is detected, an investigation is conducted. In some organizations, junior members of the team triage all the incidents and handle the less severe or lower priority cases themselves. High severity and high priority incidents are handled by more senior members of the team. You should carefully outline the escalation process so that each team member understands the criteria for raising an incident’s importance.
 
     [bookmark: pgfId-1348625]Part of the escalation process is tied to understanding how a detected event can affect the security of your network assets. For example, an attack against hosts running Microsoft SQL Server is not a high priority for organizations that use a different database server. Similarly, the attack is less important to you if you use SQL Server on your network, but you are confident that all the servers are patched and are not vulnerable to the attack. However, if someone has recently installed a copy of the vulnerable version of the software (perhaps for testing purposes), you may have a greater problem than a cursory investigation would suggest.
 
     [bookmark: pgfId-1348618]The FireSIGHT System is particularly well suited to supporting the investigation and qualification process. You can create your own event classifications, and then apply them in a way that best describes the vulnerabilities on your network. When traffic on your network triggers an event, that event is automatically prioritized and qualified for you with special indicators showing which attacks are directed against hosts that are known to be vulnerable. 
 
     [bookmark: pgfId-1348711]The incident tracking feature in the FireSIGHT System also includes a status indicator that you can change to show which incidents have been escalated.
 
     [bookmark: pgfId-1348814][bookmark: 98213]Communication
 
     [bookmark: pgfId-1349249]All incident handling processes should specify how an incident is communicated between the incident handling team and both internal and external audiences. For example, you should consider what kinds of incidents require management intervention and at what level. Also, your process should outline how and when you communicate with outside organizations. Will some incidents require that you notify law enforcement agencies? If your hosts are participating in a distributed denial of service (DDoS) against a remote site, will you inform them? Do you want to share information with organizations such as the CERT Coordination Center (CERT/CC) or FIRST?
 
     [bookmark: pgfId-1349253]The FireSIGHT System has features that you can use to gather intrusion data in standard formats such as HTML, PDF, and CSV (comma-separated values) so that you can easily share intrusion data with others. 
 
     [bookmark: pgfId-1349259]For example, CERT/CC collects standard information about security incidents on its web site. CERT/CC looks for the kinds of information that you can easily extract from the FireSIGHT System, such as:
 
      
      	 [bookmark: pgfId-1349282]information about the affected machines, including:
 
       
       	 [bookmark: pgfId-1349283]the host name and IP
 
       	 [bookmark: pgfId-1349284]the time zone
 
       	 [bookmark: pgfId-1349285]the purpose or function of the host
 
      
 
      	 [bookmark: pgfId-1349286]information about the sources of the attack, including:
 
       
       	 [bookmark: pgfId-1349287]the host name and IP
 
       	 [bookmark: pgfId-1349288]the time zone
 
       	 [bookmark: pgfId-1349289]whether you had any contact with an attacker
 
       	 [bookmark: pgfId-1349290]the estimated cost of handling the incident
 
      
 
      	 [bookmark: pgfId-1349291]a description of the incident, including:
 
       
       	 [bookmark: pgfId-1349292]dates
 
       	 [bookmark: pgfId-1349293]methods of intrusion
 
       	 [bookmark: pgfId-1349294]the intruder tools involved
 
       	 [bookmark: pgfId-1349295]the software versions and patch levels
 
       	 [bookmark: pgfId-1349296]any intruder tool output
 
       	 [bookmark: pgfId-1349297]the details of vulnerabilities exploited
 
       	 [bookmark: pgfId-1349298]the source of the attack
 
       	 [bookmark: pgfId-1349299]any other relevant information
 
      
 
     
 
     [bookmark: pgfId-1349260]You can also use the comment section of an incident to record when you communicate issues and with whom. 
 
     [bookmark: pgfId-1348580][bookmark: 70382]Containment and Recovery
 
     [bookmark: pgfId-1348191]Your incident handling process should clearly indicate what steps are taken when a host or other network component is compromised. The range of containment and recovery options stretches from applying patches to vulnerable hosts to shutting down the target and removing it from the network. You should also consider the importance, depending upon the nature and severity of the attack, of preserving evidence in case you pursue criminal charges.
 
     [bookmark: pgfId-1348984]You can use the incident feature of FireSIGHT System to maintain a record of the actions you take during the containment and recovery phase of the incident.
 
     [bookmark: pgfId-1348196][bookmark: 14202]Lessons Learned
 
     [bookmark: pgfId-1348216]Each security incident, whether or not it is a successful attack, is an opportunity to review your security policies. Do you need to update your firewall rules? Do you need a more structured approach to patch management? Are unauthorized wireless access points a new security issue? Each lesson learned should feed back into your security policies and help you prepare better for the next incident.
 
    
 
     
      [bookmark: pgfId-1346194][bookmark: 52871]Incident Ty[bookmark: marker-1364189]pes in the FireSIGHT System
 
     [bookmark: pgfId-1505449]License: Protection
 
     [bookmark: pgfId-1346202]You can assign an incident type to each incident you create. The following types are supported by default in the FireSIGHT System:
 
      
      	 [bookmark: pgfId-1346305]Intrusion
 
      	 [bookmark: pgfId-1346306]Denial of Service
 
      	 [bookmark: pgfId-1346307]Unauthorized Admin Access
 
      	 [bookmark: pgfId-1346308]Web Site Defacement
 
      	 [bookmark: pgfId-1346309]Compromise of System Integrity
 
      	 [bookmark: pgfId-1346310]Hoax
 
      	 [bookmark: pgfId-1346311]Theft
 
      	 [bookmark: pgfId-1346312]Damage
 
      	 [bookmark: pgfId-1346313]Unknown
 
     
 
     [bookmark: pgfId-1349165]You can also create your own incident types, as explained in Creating Custom Incident Types.
 
    
 
   
 
    
     [bookmark: pgfId-1498223][bookmark: 85266]Creating an Inci[bookmark: marker-1498222]dent
 
    [bookmark: pgfId-1515359]License: Protection
 
    [bookmark: pgfId-1498238]This section explains how you create an incident.
 
    [bookmark: pgfId-1457527]To create an incident:
 
    [bookmark: pgfId-1516277]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1516030]Step 1 Select Analysis > Intrusions > Incidents.
 
    [bookmark: pgfId-1516031]The Incidents page appears.
 
    [bookmark: pgfId-1407036]Step 2 Click Create Incident.
 
    [bookmark: pgfId-1407050]The Create Incident page appears.
 
    [bookmark: pgfId-1410910]If you previously copied intrusion events to the clipboard, they are displayed at the bottom of the page. See Using the Clipboard for information about using the clipboard.
 
    [bookmark: pgfId-1523508]Step 3 From the Type drop-down menu, select the option that best describes the incident.
 
    [bookmark: pgfId-1523518]Step 4 In the Time Spent field, enter the amount of time you spent on the incident in the #d #h #m #s format, where # represents the number of days, hours, minutes, or seconds.
 
    [bookmark: pgfId-1337494]Step 5 In the Summary text box, type a short description (up to 255 alphanumeric characters spaces, and symbols) of the incident.
 
    [bookmark: pgfId-1096794]Step 6 In the Add Comment text box, type a more complete description (up to 8191 alphanumeric characters, spaces and symbols) for the incident.
 
    [bookmark: pgfId-1096805]Step 7 Do you want to add events to the incident?
 
     
      
      	 [bookmark: pgfId-1096823]If  yes , select the events on the clipboard and click  Add to Incident .
 
     
 
    
 
    [bookmark: pgfId-1349853]You can also add all the events from the clipboard by clicking Add All to Incident.
 
     
      
      	 [bookmark: pgfId-1096829]If  no , click  Save .
 
     
 
    
 
    [bookmark: pgfId-1096868]In either case, the incident is saved with the information you entered.
 
     
      
    
 
    
 
    [bookmark: pgfId-1096880]Note If you want to add individual events from more than one page on the clipboard, you must add the events from one page, then add the events from the other pages separately.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1498202][bookmark: 73461]Editing an Incid[bookmark: marker-1498201]ent
 
    [bookmark: pgfId-1523775]License: Protection
 
    [bookmark: pgfId-1523800]You can update an incident as you collect more information. You can also add or delete events from the incident as your investigation progresses.
 
    [bookmark: pgfId-1050802]To edit an incident:
 
    [bookmark: pgfId-1516302]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1513001]Step 1 Select Analysis > Intrusions > Incidents.
 
    [bookmark: pgfId-1097264]The Incidents page appears.
 ) next to the incident you want to edit. 
    
 
    [bookmark: pgfId-1353026]Step 3 You can edit any of the following aspects of the incident:
 
     
      
      	 [bookmark: pgfId-1097283]change the status
 
      	 [bookmark: pgfId-1097287]change the type
 
      	 [bookmark: pgfId-1097289]add events from the clipboard
 
      	 [bookmark: pgfId-1097292]delete events
 
     
 
    
 
    [bookmark: pgfId-1097303]Step 4 In the Time Spent field, enter the amount of additional time you spent on the incident.
 
    [bookmark: pgfId-1434688]Step 5 In the Add Comment text box, indicate your changes to the incident (up to 8191 alphanumeric characters, spaces and symbols) for the incident.
 
    [bookmark: pgfId-1097308]Step 6 Optionally, you can add or delete events from the incident:
 
     
      
      	 [bookmark: pgfId-1097315]To add events from the clipboard, select the events on the clipboard and click  Add to Incident .
 
      	 [bookmark: pgfId-1375164]To add all the events from the clipboard, click  Add All to Incident .
 
      	 [bookmark: pgfId-1097329]To delete specific events from the incident, select the events and click  Delete .
 
      	 [bookmark: pgfId-1097330]To delete all events from the incident, click  Delete All .
 
      	 [bookmark: pgfId-1097331]To update the incident without adding or deleting events, click  Save .
 
     
 
    
 
    [bookmark: pgfId-1097332]Your changes to the incident are saved.
 
    [bookmark: pgfId-1534986]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1161562][bookmark: 40090]Generating Inci[bookmark: marker-1161561]dent Reports
 
    [bookmark: pgfId-1515398]License: Protection
 
    [bookmark: pgfId-1349900]You can use the FireSIGHT System to generate incident reports that can include the incident summary, incident status, and any comments along with information from the events you add to the incident. You can also specify whether you want to include event summary information in the report.
 
    [bookmark: pgfId-1355219]To generate an incident report:
 
    [bookmark: pgfId-1516315]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1512967]Step 1 Select Analysis > Intrusions > Incidents.
 
    [bookmark: pgfId-1407067]The Incidents page appears.
 ) next to the incident you want to include in your report. 
    
 
    [bookmark: pgfId-1355251]Step 3 You have two options:
 
     
      
      	 [bookmark: pgfId-1355252]To include all the events from the incident in the report, click  Generate Report All .
 
      	 [bookmark: pgfId-1355256]To include specific events from the incident in the report, select the check boxes next to the events you want and click  Generate Report .
 
     
 
    
 
    [bookmark: pgfId-1355262]In either case, the Generate Report page appears, including the options for incident reports.
 
    [bookmark: pgfId-1355548]Step 4 Type a name for the report. You can use alphanumeric characters, periods, and spaces.
 
    [bookmark: pgfId-1355266]Step 5 In Incident Report Sections, select the check boxes for the portions of the incident that you want to include in the report: status, summary, and comments.
 
    [bookmark: pgfId-1355378]Step 6 If you want to include event information in the report, select the workflow you want to use and then, in Report Sections, specify whether you want to include event summary information.
 
    [bookmark: pgfId-1355400]Step 7 Select the check boxes next to the workflow pages you want to include in the report.
 
    [bookmark: pgfId-1355505]Step 8 Select the check boxes next to the output formats you want to use for the report: PDF, HTML, and CSV.
 
     
      
    
 
    
 
    [bookmark: pgfId-1355554]Note CSV-based incident reports include only event information. They do not include the status, summary, or comments from the incident.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1375199]Step 9 Click Generate Report and confirm that you want to update the report profile.
 
    [bookmark: pgfId-1375204]The report is generated.
 
    [bookmark: pgfId-1534998]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1346558][bookmark: 20530]Creating Custom Inci[bookmark: marker-1350110]dent Types
 
    [bookmark: pgfId-1523687]License: Protection
 
    [bookmark: pgfId-1523691]The FireSIGHT System is delivered with the following incident types that you can use to classify your incidents:
 
     
     	 [bookmark: pgfId-1523692]Compromise of System Integrity
 
     	 [bookmark: pgfId-1523693]Damage
 
     	 [bookmark: pgfId-1523694]Denial of Service
 
     	 [bookmark: pgfId-1523695]Hoax
 
     	 [bookmark: pgfId-1523696]Intrusion
 
     	 [bookmark: pgfId-1523697]Theft
 
     	 [bookmark: pgfId-1523698]Unauthorized Admin Access
 
     	 [bookmark: pgfId-1523699]Unknown
 
     	 [bookmark: pgfId-1523700]Web Site Defacement
 
    
 
    [bookmark: pgfId-1523701]If these incident types do not meet your needs, you can add your own. Note that you cannot delete any custom incident types.
 
    [bookmark: pgfId-1350063]To create a new incident type:
 
    [bookmark: pgfId-1516344]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-1407088]Step 1 Select Analysis > Intrusions > Incidents.
 
    [bookmark: pgfId-1350085]The Incident page appears.
 
    [bookmark: pgfId-1407110]Step 2 Click Create Incident.
 
    [bookmark: pgfId-1407111]The Create Incident page appears.
 
    [bookmark: pgfId-1350090]Step 3 In the Type area, click Types.
 
    [bookmark: pgfId-1350091]The incident management Types page appears. The default incident types are listed at the bottom of the page.
 
    [bookmark: pgfId-1350092]Step 4 In the Incident Type Name field, type a name for the new incident type.
 
    [bookmark: pgfId-1517120]Use alphanumeric characters and spaces.
 
    [bookmark: pgfId-1517121]Step 5 Click Add.
 
    [bookmark: pgfId-1517122]The new incident type is added. 
 
    [bookmark: pgfId-1360307]Step 6 Click Done to close the pop-up window and return to the Incidents page.
 
    [bookmark: pgfId-1360308]You can use the new incident type the next time you create or edit an incident.
 
    [bookmark: pgfId-1535021]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2044947][bookmark: 42062]Configur[bookmark: marker-2044945]ing External Alerting 
      
      
 
     
 
 
    [bookmark: pgfId-2044951]While the FireSIGHT System provides various views of events within the web interface, you may want to configure external event notification to facilitate constant monitoring of critical systems. You can configure the FireSIGHT System to generate alerts that notify you via email, SNMP trap, or syslog when one of the following is generated: 
 
     
     	 [bookmark: pgfId-2018899]an intrusion event with a specific impact flag
 
     	 [bookmark: pgfId-2019028]a specific type of discovery event
 
     	 [bookmark: pgfId-2042533]a network-based malware event or retrospective malware event
 
     	 [bookmark: pgfId-2018973]a correlation event, triggered by a specific correlation policy violation
 
     	 [bookmark: pgfId-2027465]a connection event, triggered by a specific access control rule
 
     	 [bookmark: pgfId-2027466]a specific status change for a module in a health policy
 
    
 
    [bookmark: pgfId-2044468]To have the system send these alerts, you must first create an alert response, which is a set of configurations that allows the FireSIGHT System to interact with the external system where you plan to send the alert. Those configurations may specify, for example, an email relay host, SNMP alerting parameters, or syslog facilities and priorities.
 
    [bookmark: pgfId-2044472]After you create the alert response, you associate it with the event that you want to use to trigger the alert. Note that the process for associating alert responses with events is different depending on the type of event:
 
     
     	 [bookmark: pgfId-2026901]You associate alert responses with impact flags, discovery events, and malware events using their own configuration pages.
 
     	 [bookmark: pgfId-2026902]You associate correlation events with alert responses (and remediation responses; see Creating Remediations) in your correlation policies.
 
     	 [bookmark: pgfId-2026886]You associate SNMP and syslog alert responses with logged connections using access control rules and policies. Email alerting is not supported for logged connections.
 
     	 [bookmark: pgfId-2044692]You associate alert responses with health module status changes using the health monitor.
 
    
 
    [bookmark: pgfId-2044696]There is another type of alerting you can perform in the FireSIGHT System, which is to configure email, SNMP, and syslog intrusion event notifications for individual intrusion events, regardless of impact flag. You configure these notifications in intrusion policies; see Configuring External Alerting for Intrusion Rules and Adding SNMP Alerts. The following table explains the licenses you must have to generate alerts.
 
     
      [bookmark: pgfId-2021242]
 
      
       
        
        [bookmark: pgfId-2021216]Table 43-1 License Requirements for Generating Alerts 
 
        
        
         
         	 
           
           [bookmark: pgfId-2021220]To generate an alert based on... 
          
  
         	 
           
           [bookmark: pgfId-2021222]You need this license... 
          
  
        
 
         
         	[bookmark: pgfId-2026489]an intrusion event with a specific impact flag
  
         	[bookmark: pgfId-2026497]FireSIGHT + Protection
  
        
 
         
         	[bookmark: pgfId-2021228]a specific type of discovery event
  
         	[bookmark: pgfId-2021233]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-2042781]a network-based malware event
  
         	[bookmark: pgfId-2042783]Malware
  
        
 
         
         	[bookmark: pgfId-2021235]a correlation policy violation
  
         	[bookmark: pgfId-2021237]the license required to trigger the policy violation
  
        
 
         
         	[bookmark: pgfId-2021239]a connection event
  
         	[bookmark: pgfId-2021241]the license required to log the connection
  
        
 
         
         	[bookmark: pgfId-2027378]health module status changes
  
         	[bookmark: pgfId-2027380]Any
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2018625]For more information, see:
 
      
      	 [bookmark: pgfId-2019160]Working with Alert Responses
 
      	 [bookmark: pgfId-2019179]Configuring Impact Flag Alerting
 
      	 [bookmark: pgfId-2026252]Configuring Discovery Event Alerting
 
      	 [bookmark: pgfId-2042536]Configuring Advanced Malware Protection Alerting
 
      	 [bookmark: pgfId-2026319]Adding Responses to Rules and White Lists
 
      	 [bookmark: pgfId-2027641]Logging Connections in Network Traffic
 
      	 [bookmark: pgfId-2027645]Configuring Health Monitor Alerts
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2027735][bookmark: 64563]Working with Alert Responses
 
    [bookmark: pgfId-2020496]License: Any
 
    [bookmark: pgfId-2021012]The first step in configuring external alerting is to create an alert response, which is a set of configurations that allows the FireSIGHT System to interact with the external system where you plan to send the alert. You can create alert responses to send alerts via email, a simple network management protocol (SNMP) trap, or a system log (syslog).
 
    [bookmark: pgfId-2028468]The information you receive in an alert depends on the type of event that triggered the alert. For example, an impact flag alert contains timestamp, intrusion rule, impact flag, and event description information. As another example, discovery event alerts also contain timestamp and description information, as well as discovery event type information. 
 
    [bookmark: pgfId-2029104]If you are using an alert response in a correlation policy, the information in the alert depends on the type of event that triggered the correlation policy violation.
 
     
      
    
 
    
 
    [bookmark: pgfId-2028472]Note If you configure an alert as a response to a correlation rule that contains a connection tracker, the alert information you receive is the same as that for alerts on traffic profile changes, even if the correlation rule itself is based on a different kind of event.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2026333]When you create an alert response, it is automatically enabled. Only enabled alert responses can generate alerts. To stop alerts from being generated, you can temporarily disable alert responses rather than deleting your configurations.
 
    [bookmark: pgfId-2055217]You manage alert responses on the Alerts page (Policies > Actions > Alerts). The slider next to each alert response indicates whether it is active; only enabled alert responses can generate alerts. The page also indicates whether the alert response is being used in a configuration, for example, to log connections in an access control rule. You can sort alert responses by name, type, in use status, and enabled/disabled status by clicking the appropriate column header; click the column header again to reverse the sort.
 
    [bookmark: pgfId-2032638]For more information, see:
 
     
     	 [bookmark: pgfId-2021392]Creating an Email Alert Response
 
     	 [bookmark: pgfId-2028124]Creating an SNMP Alert Response
 
     	 [bookmark: pgfId-2062303]Creating a Syslog Alert Response
 
     	 [bookmark: pgfId-2062310]Modifying an Alert Response
 
     	 [bookmark: pgfId-2062314]Deleting an Alert Response
 
     	 [bookmark: pgfId-2022226]Enabling and Disabling Alert Responses
 
    
 
     
      [bookmark: pgfId-2022229][bookmark: 19460]Creating an Email Alert Re[bookmark: marker-2034469]sponse
 
     [bookmark: pgfId-2060795]License: Any
 
     [bookmark: pgfId-2060796]Note that you cannot perform email alerting on logged connections in an access control policy. 
 
     [bookmark: pgfId-2029043]Before you create an email alert response, you should make sure that the Defense Center can reverse-resolve its own IP address. You should also configure your mail relay host as described in Configuring a Mail Relay Host and Notification Address.
 
     [bookmark: pgfId-2022045]To create an email alert response:
 
     [bookmark: pgfId-2029625]Access: Admin
 
     
 
     [bookmark: pgfId-2022047]Step 1 Select Policies > Actions > Alerts.
 
     [bookmark: pgfId-2022048]The Alerts page appears.
 
     [bookmark: pgfId-2022049]Step 2 From the Create Alert drop-down menu, select Create Email Alert.
 
     [bookmark: pgfId-2022050]The Create Email Alert Configuration pop-up window appears.
 
     [bookmark: pgfId-2022057]Step 3 In the Name field, type the name you want to use to identify the alert response.
 
     [bookmark: pgfId-2022058]Step 4 In the To field, type the email addresses where you want to send alerts.
 
     [bookmark: pgfId-2022242]Separate email addresses with commas.
 
     [bookmark: pgfId-2022059]Step 5 In the From field, type the email address that you want to appear as the sender of the alert.
 
     [bookmark: pgfId-2022060]Step 6 Next to Relay Host, verify the listed mail server is the one that you want to use to send the alert.
 ) to display the System Policy page in a pop-up window, then follow the directions in 
     Configuring a Mail Relay Host and Notification Address. You must apply the system policy after you edit it for your changes to take effect. 
     
 
     [bookmark: pgfId-2022066]Step 7 Click Save.
 
     [bookmark: pgfId-2022067]The alert response is saved and is automatically enabled.
 
     [bookmark: pgfId-2063432]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2018367][bookmark: 35376]Creating an SN[bookmark: marker-2034488]MP Alert Response
 
     [bookmark: pgfId-2018396]License: Any
 
     [bookmark: pgfId-2022407]You can create SNMP alert responses using SNMPv1, SNMPv2, or SNMPv3.
 
      
       
     
 
     
 
     [bookmark: pgfId-2075734]Note When selecting SNMP versions for the SNMP protocol, note that SNMPv2 only supports read-only communities and SNMPv3 only supports read-only users. SNMPv3 also supports encryption with AES128.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2040223]Note If you want to monitor 64-bit values with SNMP, you must use SNMPv2 or SNMPv3. SNMPv1 does not support 64-bit monitoring.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2040017]If your network management system requires the Defense Center’s management information base (MIB) file, you can obtain it at /etc/sf/DCEALERT.MIB.
 
     [bookmark: pgfId-2022520]To create an SNMP alert response:
 
     [bookmark: pgfId-2029646]Access: Admin
 
     
 
     [bookmark: pgfId-2022641]Step 1 Select Policies > Actions > Alerts.
 
     [bookmark: pgfId-2022642]The Alerts page appears.
 
     [bookmark: pgfId-2022643]Step 2 From the Create Alert drop-down menu, select Create SNMP Alert.
 
     [bookmark: pgfId-2022742]The Create SNMP Alert Configuration pop-up window appears.
 
     [bookmark: pgfId-2023152]Step 3 In the Name field, type the name that you want to use to identify the SNMP response.
 
     [bookmark: pgfId-2022953]Step 4 In the Trap Server field, type the hostname or IP address of the SNMP trap server, using alphanumeric characters.
 
     [bookmark: pgfId-2032767]Note that the system does not warn you if you enter an invalid IPv4 address (such as 192.169.1.456) in this field. Instead, the invalid address is treated as a hostname.
 
     [bookmark: pgfId-2022532]Step 5 From the Version drop-down list, select the SNMP version you want to use.
 
     [bookmark: pgfId-2022533]SNMP v3 is the default. If you select SNMP v1 or SNMP v2, different options appear.
 
     [bookmark: pgfId-2022545]Step 6 Which version of SNMP did you select?
 
      
       
       	 [bookmark: pgfId-2023193]For SNMP v1 or SNMP v2, type the SNMP community name, using alphanumeric characters or the special characters  * or  $, in the  Community String field and skip to step  12 .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2076091]Note SNMPv2 only supports read-only communities.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-2031620]For SNMP v3, type the name of the user that you want to authenticate with the SNMP server in the  User Name field and continue with the next step.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2076166]Note SNMPv3 only supports read-only users. SNMPv3 also supports encryption with AES128.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2023276]Step 7 From the Authentication Protocol drop-down list, select the protocol you want to use for authentication.
 
     [bookmark: pgfId-2023386]Step 8 In the Authentication Password field, type the password required for authentication with the SNMP server.
 
     [bookmark: pgfId-2023387]Step 9 From the Privacy Protocol list, select None to use no privacy protocol or DES to use Data Encryption Standard as the privacy protocol.
 
     [bookmark: pgfId-2031574]Step 10 In the Privacy Password field, type the privacy password required by the SNMP server.
 
     [bookmark: pgfId-2031575]Step 11 In the Engine ID field, type an identifier for the SNMP engine, in hexadecimal notation, using an even number of digits.
 
     [bookmark: pgfId-2031576]When you use SNMPv3, the system uses an Engine ID value to encode the message. Your SNMP server requires this value to decode the message. 
 
     [bookmark: pgfId-2033580]Cisco recommends that you use the hexadecimal version of the Defense Center’s IP address. For example, if the Defense Center has an IP address of 10.1.1.77, use 0a01014D0.
 
     [bookmark: pgfId-2023501]Step 12 [bookmark: 32704]Click Save.
 
     [bookmark: pgfId-2023541]The alert response is saved and is automatically enabled.
 
     [bookmark: pgfId-2063453]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2018585][bookmark: 16300]Creating a Syslog Al[bookmark: marker-2034496]ert Response
 
     [bookmark: pgfId-2018586]License: Any
 
     [bookmark: pgfId-2023562]When configuring a syslog alert response, you can specify the severity and facility associated with the syslog messages to ensure that they are processed properly by the syslog server. The facility indicates the subsystem that creates the message and the severity defines the severity of the message. Facilities and severities are not displayed in the actual message that appears in the syslog, but are instead used to tell the system that receives the syslog message how to categorize it.
 
      
       
     
 
     
 
     [bookmark: pgfId-2023563]Tip For more detailed information about how syslog works and how to configure it, refer to the documentation for your system. On UNIX systems, the man pages for syslog and syslog.conf provide conceptual information and configuration instructions.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2023564]Although you can select any type of facility when creating a syslog alert response, you should select one that makes sense based on your syslog server; not all syslog servers support all facilities. For UNIX syslog servers, the syslog.conf file should indicate which facilities are saved to which log files on the server. 
 
     [bookmark: pgfId-2023573]The following table list[bookmark: marker-2023572]s the syslog facilities you can select.
 
      
       [bookmark: pgfId-2023656]
 
       
        
         
         [bookmark: pgfId-2023580]Table 43-2 [bookmark: 15541]Available Syslog Facilities 
 
         
         
          
          	 
            
            [bookmark: pgfId-2023584]Facility 
           
  
          	 
            
            [bookmark: pgfId-2023586]Description 
           
  
         
 
          
          	[bookmark: pgfId-2050382]ALERT
  
          	[bookmark: pgfId-2050384]An alert message.
  
         
 
          
          	[bookmark: pgfId-2050399]AUDIT
  
          	[bookmark: pgfId-2050401]A message generated by the audit subsystem.
  
         
 
          
          	[bookmark: pgfId-2024437]AUTH
  
          	[bookmark: pgfId-2024439]A message associated with security and authorization.
  
         
 
          
          	[bookmark: pgfId-2024441]AUTHPRIV
  
          	[bookmark: pgfId-2024443]A restricted access message associated with security and authorization. On many systems, these messages are forwarded to a secure file.
  
         
 
          
          	[bookmark: pgfId-2050412]CLOCK
  
          	[bookmark: pgfId-2050414]A message generated by the clock daemon.
 [bookmark: pgfId-2050644]Note that syslog servers running a Windows operating system will use the CLOCK facility. 
  
         
 
          
          	[bookmark: pgfId-2024450]CRON
  
          	[bookmark: pgfId-2024452]A message generated by the clock daemon.
 [bookmark: pgfId-2050854]Note that syslog servers running a Linux operating system will use the CRON facility. 
  
         
 
          
          	[bookmark: pgfId-2024454]DAEMON
  
          	[bookmark: pgfId-2024456]A message generated by a system daemon.
  
         
 
          
          	[bookmark: pgfId-2024458]FTP
  
          	[bookmark: pgfId-2024460]A message generated by the FTP daemon.
  
         
 
          
          	[bookmark: pgfId-2024462]KERN
  
          	[bookmark: pgfId-2024464]A message generated by the kernel. On many systems, these messages are printed to the console when they appear.
  
         
 
          
          	[bookmark: pgfId-2024466]LOCAL0-LOCAL7
  
          	[bookmark: pgfId-2024468]A message generated by an internal process.
  
         
 
          
          	[bookmark: pgfId-2024470]LPR
  
          	[bookmark: pgfId-2024472]A message generated by the printing subsystem.
  
         
 
          
          	[bookmark: pgfId-2024474]MAIL
  
          	[bookmark: pgfId-2024476]A message generated by a mail system.
  
         
 
          
          	[bookmark: pgfId-2024478]NEWS
  
          	[bookmark: pgfId-2024480]A message generated by the network news subsystem.
  
         
 
          
          	[bookmark: pgfId-2050364]NTP
  
          	[bookmark: pgfId-2050366]A message generated by the NTP daemon.
  
         
 
          
          	[bookmark: pgfId-2024486]SYSLOG
  
          	[bookmark: pgfId-2024488]A message generated by the syslog daemon.
  
         
 
          
          	[bookmark: pgfId-2024490]USER
  
          	[bookmark: pgfId-2024492]A message generated by a user-level process.
  
         
 
          
          	[bookmark: pgfId-2024494]UUCP
  
          	[bookmark: pgfId-2024496]A message generated by the UUCP subsystem.
  
         
 
         
       
 
      
 
      [bookmark: pgfId-2027192]The following table lists the standard[bookmark: marker-2023657] syslog severity levels you can select.
 
     
 
      
       [bookmark: pgfId-2023704]
 
       
        
         
         [bookmark: pgfId-2023665]Table 43-3 [bookmark: 83000]Syslog Severity Levels 
 
         
         
          
          	 
            
            [bookmark: pgfId-2023669]Level 
           
  
          	 
            
            [bookmark: pgfId-2023671]Description 
           
  
         
 
          
          	[bookmark: pgfId-2024518]ALERT
  
          	[bookmark: pgfId-2024520]A condition that should be corrected immediately.
  
         
 
          
          	[bookmark: pgfId-2024514]CRIT
  
          	[bookmark: pgfId-2024516]A critical condition.
  
         
 
          
          	[bookmark: pgfId-2024522]DEBUG
  
          	[bookmark: pgfId-2024524]Messages that contain debugging information.
  
         
 
          
          	[bookmark: pgfId-2024526]EMERG 
  
          	[bookmark: pgfId-2024528]A panic condition broadcast to all users.
  
         
 
          
          	[bookmark: pgfId-2024530]ERR
  
          	[bookmark: pgfId-2024532]An error condition.
  
         
 
          
          	[bookmark: pgfId-2024534]INFO
  
          	[bookmark: pgfId-2024536]Informational messages.
  
         
 
          
          	[bookmark: pgfId-2024538]NOTICE
  
          	[bookmark: pgfId-2024540]Conditions that are not error conditions, but require attention.
  
         
 
          
          	[bookmark: pgfId-2024542]WARNING
  
          	[bookmark: pgfId-2024544]Warning messages.
  
         
 
         
       
 
      
 
      [bookmark: pgfId-2024178]Before you start sending syslog alerts, make sure that the syslog server can accept remote messages.
 
      [bookmark: pgfId-2024179]To create a syslog alert:
 
      [bookmark: pgfId-2029539]Access: Admin
 
      
 
      [bookmark: pgfId-2024223]Step 1 Select Policies > Actions > Alerts.
 
      [bookmark: pgfId-2024224]The Alerts page appears.From the Create Alert drop-down menu, select Create Syslog Alert.
 
      [bookmark: pgfId-2024226]The Create Syslog Alert Configuration pop-up window appears.
 
      [bookmark: pgfId-2033246]Step 2 In the Name field, type the name you want to use to identify the saved response.
 
      [bookmark: pgfId-2033247]Step 3 In the Host field, type the hostname or IP address of your syslog server.
 
      [bookmark: pgfId-2033248]Note that the system does not warn you if you enter an invalid IPv4 address (such as 192.168.1.456) in this field. Instead, the invalid address is treated as a hostname.
 
      [bookmark: pgfId-2023720]Step 4 In the Port field, type the port the server uses for syslog messages. 
 
      [bookmark: pgfId-2024411]By default, this value is 514.
 
      [bookmark: pgfId-2023721]Step 5 From the Facility list, select a facility.
 
      [bookmark: pgfId-2023725]See the Available Syslog Facilities table for a list of the available facilities.
 
      [bookmark: pgfId-2023726]Step 6 From the Severity list, select a severity.
 
      [bookmark: pgfId-2023730]See the Syslog Severity Levels table for a list of the available severities.
 
      [bookmark: pgfId-2023731]Step 7 In the Tag field, type the tag name that you want to appear with the syslog message.
 
      [bookmark: pgfId-2024608]Use only alphanumeric characters in tag names. You cannot use spaces or underscores.
 
      [bookmark: pgfId-2053544]As an example, if you wanted all messages sent to the syslog to be preceded with FromDC, type FromDC in the field.
 
      [bookmark: pgfId-2053545]Step 8 Click Save.
 
      [bookmark: pgfId-2028214]The alert response is saved and is automatically enabled.
 
      [bookmark: pgfId-2063469]
 
       
       
 
      
 
      
 
     
 
    
 
     
      [bookmark: pgfId-2028216][bookmark: 12806]Modifying an Alert Res[bookmark: marker-2034523]ponse
 
     [bookmark: pgfId-2031836]License: Any
 
     [bookmark: pgfId-2031875]For most types of alerting, if an alert response is enabled and in use, changes to the alert response take effect immediately. However, for alert responses used in access control rules to log connection events, changes do not take effect until you reapply the access control policy.
 
     [bookmark: pgfId-2031877]To edit an alert response:
 
     [bookmark: pgfId-2031700]Access: Admin
 
     
 
     [bookmark: pgfId-2025017]Step 1 Select Policies > Actions > Alerts.
 
     [bookmark: pgfId-2025018]The Alerts page appears.
 ). 
     
 
     [bookmark: pgfId-2025059]A configuration pop-up window for that alert response appears.
 
     [bookmark: pgfId-2025081]Step 3 Make changes as needed.
 
     [bookmark: pgfId-2025137]Step 4 Click Save.
 
     [bookmark: pgfId-2025138]The alert response is saved.
 
     [bookmark: pgfId-2063491]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2024735][bookmark: 95899]Deleting an Alert Res[bookmark: marker-2034528]ponse
 
     [bookmark: pgfId-2028902]License: Any
 
     [bookmark: pgfId-2024767]You can delete any alert response that is not in use.
 
     [bookmark: pgfId-2024768]To delete an alert response:
 
     [bookmark: pgfId-2031715]Access: Admin
 
     
 
     [bookmark: pgfId-2024817]Step 1 Select Policies > Actions > Alerts.
 
     [bookmark: pgfId-2024818]The Alerts page appears.
 ). 
     
 
     [bookmark: pgfId-2025676]Step 3 Confirm that you want to delete the alert response.
 
     [bookmark: pgfId-2024773]The alert response is deleted.
 
     [bookmark: pgfId-2063503]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2018510][bookmark: 38030]Enabling and Disab[bookmark: marker-2034533]ling Alert Responses
 
     [bookmark: pgfId-2028931]License: Any
 
     [bookmark: pgfId-2025464]Only enabled alert responses can generate alerts. To stop alerts from being generated, you can temporarily disable alert responses rather than deleting your configurations. Note that if an alert is in use when you disable it, it is still considered in use even though it is disabled.
 
     [bookmark: pgfId-2024919]To enable or disable an alert response:
 
     [bookmark: pgfId-2031728]Access: Admin
 
     
 
     [bookmark: pgfId-2025271]Step 1 Select Policies > Actions > Alerts.
 
     [bookmark: pgfId-2025272]The Alerts page appears.
 
     [bookmark: pgfId-2025273]Step 2 Next to the alert response you want to enable or disable, click the enable/disable slider.
 
     [bookmark: pgfId-2025342]If the alert response was enabled, it is disabled. If it was disabled, it is enabled.
 
     [bookmark: pgfId-2063519]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2018748][bookmark: 24066]Configuring Imp[bookmark: marker-2034557]act Flag Alerting
 
    [bookmark: pgfId-2018607]License: Protection
 
    [bookmark: pgfId-2029322]You can configure the system to alert you whenever an intrusion event with a specific impact flag occurs. Impact flags help you evaluate the impact an intrusion has on your network by correlating intrusion data, network discovery data, and vulnerability information. For more information, see Using Impact Levels to Evaluate Events.
 
    [bookmark: pgfId-2029242]To configure impact flag alerting:
 
    [bookmark: pgfId-2031748]Access: Admin
 
    
 
    [bookmark: pgfId-2025871]Step 1 Select Policies > Actions > Alerts, then select the Impact Flag Alerts tab.
 
    [bookmark: pgfId-2025777]The Impact Flag Alerts page appears.
 
    [bookmark: pgfId-2025782]Step 2 In the Alerts section, select the alert response you want to use for each alert type.
 
    [bookmark: pgfId-2025929]To create a new alert response, select New from any drop-down list. For more information, see Working with Alert Responses.
 
    [bookmark: pgfId-2025787]Step 3 In the Impact Configuration section, select the check boxes that correspond to the alerts you want to receive for each impact flag.
 
    [bookmark: pgfId-2025793]Step 4 Click Save.
 
    [bookmark: pgfId-2046222]Your impact flag alerting settings are saved.
 
    [bookmark: pgfId-2063535]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2018685][bookmark: 90899]Configuring Discov[bookmark: marker-2034571]ery Event Alerting
 
    [bookmark: pgfId-2018723]License: FireSIGHT
 
    [bookmark: pgfId-2029397]You can configure the system to alert you whenever a specific type of discovery event occurs. For information about the different event types, see Understanding Discovery Event Types and Understanding Host Input Event Types.
 
    [bookmark: pgfId-2029292]Note that to generate an alert based on a discovery event type, you must configure your network discovery policy to log that event type; see Configuring Discovery Event Logging. By default, logging is enabled for all event types.
 
    [bookmark: pgfId-2026161]To configure discovery event alerting:
 
    [bookmark: pgfId-2031769]Access: Admin
 
    
 
    [bookmark: pgfId-2026040]Step 1 Select Policies > Actions > Alerts, then select the Discovery Event Alerts tab.
 
    [bookmark: pgfId-2026041]The Discovery Event Alerts page appears.
 
    [bookmark: pgfId-2026228]Step 2 In the Alerts section, select the alert response you want to use for each alert type.
 
    [bookmark: pgfId-2026047]To create a new alert response, select New from any drop-down list. For more information, see Working with Alert Responses.
 
    [bookmark: pgfId-2026051]Step 3 In the Events Configuration section, select the check boxes that correspond to the alerts you want to receive for each discovery event type.
 
    [bookmark: pgfId-2026291]Step 4 Click Save.
 
    [bookmark: pgfId-2046116]Your discovery event alerting settings are saved.
 
    [bookmark: pgfId-2063547]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2042626][bookmark: 53768]Configur[bookmark: marker-2042825]ing Advanced Malware Protection Alerting
 
    [bookmark: pgfId-2042630]License: Malware
 
    [bookmark: pgfId-2050216]Supported Devices: Series 3 or virtual
 
    [bookmark: pgfId-2050237]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-2046061]You can configure the system to alert you whenever any network-based malware event, including a retrospective event, is generated. You cannot, however, alert on endpoint-based (FireAMP) malware events. For information on malware events, see Working with Malware Events.
 
    [bookmark: pgfId-2060975]To generate alerts based on malware events, you must create a file policy that performs malware cloud lookups, then associate that policy with an access control rule. For more information, see Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-2060982]To configure malware event alerting:
 
    [bookmark: pgfId-2042932]Access: Admin
 
    
 
    [bookmark: pgfId-2042933]Step 1 Select Policies > Actions > Alerts, then select the Advanced Malware Protections Alerts tab.
 
    [bookmark: pgfId-2042934]The Advanced Malware Protection Alerts page appears.
 
    [bookmark: pgfId-2042939]Step 2 In the Alerts section, select the alert response you want to use for each alert type.
 
    [bookmark: pgfId-2042940]To create a new alert response, select New from any drop-down list. For more information, see Working with Alert Responses.
 
    [bookmark: pgfId-2042944]Step 3 In the Event Configuration section, select the check boxes that correspond to the alerts you want to receive for each malware event type.
 
    [bookmark: pgfId-2043653]Keep in mind that All network-based malware events includes Retrospective Events.
 
    [bookmark: pgfId-2042945]Step 4 Click Save.
 
    [bookmark: pgfId-2046189]Your malware event alerting settings are saved.
 
    [bookmark: pgfId-2063562]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2018567]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1056300][bookmark: 42062]Configuring External [bookmark: marker-1608792]Alerting for Intrusion Rules 
      
      
 
     
 
 
    [bookmark: pgfId-2018771]While the FireSIGHT System provides various views of intrusion events within the web interface, some enterprises prefer to define external intrusion event notification to facilitate constant monitoring of critical systems. If you want to immediately notify a specific person of critical events, you can set up email alerts to do so. You can also enable logging to syslog facilities or send event data to an SNMP trap server. 
 
    [bookmark: pgfId-2019475]Within each intrusion policy, you can specify intrusion event notification limits, set up intrusion event notification to external logging facilities, and configure external responses to intrusion events.
 
     
      
    
 
    
 
    [bookmark: pgfId-1392108]Tip Some analysts prefer not to receive multiple alerts for the same intrusion event, but want to control how often they are notified of a given intrusion event occurrence. See Filtering Intrusion Event Notification Per Policy for more information.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2019838]There is another type of alerting you can perform in the FireSIGHT System, outside of your intrusion policies. You can configure email, SNMP, and syslog alert responses for other types of events, including intrusion events with specific impact flags, or connection events logged by specific access control rules. For more information, see Configuring External Alerting.
 
    [bookmark: pgfId-1478832]See the following sections for more information on external intrusion event notification:
 
     
     	 [bookmark: pgfId-1870324]Using SNMP Responses describes the options you can configure to send event data to specified SNMP trap servers and provides the procedure for specifying the SNMP alerting options.
 
     	 [bookmark: pgfId-1801760]Using Syslog Responses describes the options you can configure to send event data to an external syslog and provides the procedure for specifying the syslog alerting options.
 
     	 [bookmark: pgfId-1874611]Understanding Email Alerting describes the options you can configure to send notifications of intrusion events by email.
 
    
 
   
 
    
     [bookmark: pgfId-1872629][bookmark: 54493]Using SN[bookmark: marker-1872628]MP Responses
 
    [bookmark: pgfId-2007368]License: Protection
 
    [bookmark: pgfId-2042002]An SNMP trap is a network management notification. You can configure the device to send intrusion event notifications as SNMP traps, also known as SNMP alerts. Each SNMP alert includes:
 
     
     	 [bookmark: pgfId-2042003]the name of the server generating the trap
 
     	 [bookmark: pgfId-2042004]the IP address of the device that detected it
 
     	 [bookmark: pgfId-2042005]the name of the device that detected it
 
     	 [bookmark: pgfId-2042006]the event data
 
    
 
    [bookmark: pgfId-2042007]You can set a variety of SNMP alerting parameters. Available parameters vary depending on the version of SNMP you use. For details on enabling and disabling SNMP alerting, see Configuring Advanced Settings in an Intrusion Policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-2041879]Tip If your network management system requires a management information base file (MIB), you can obtain it from the Defense Center at /etc/sf/DCEALERT.MIB.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2041884][bookmark: 98026]SNMP v2 Options
 
     
     [bookmark: pgfId-2042042]Option 
    
 
     
     [bookmark: pgfId-2042044]Description 
    
 
    [bookmark: pgfId-2042046]Trap Type
 
    [bookmark: pgfId-2042048]The trap type to use for IP addresses that appear in the alerts.
 
    [bookmark: pgfId-2042049]If your network management system correctly renders the INET_IPV4 address type, then you can select as Binary. Otherwise, select as String. For example, HP Openview requires the string type.
 
    [bookmark: pgfId-2042051]Trap Server
 
    [bookmark: pgfId-2042053]The server that will receive SNMP traps notification.
 
    [bookmark: pgfId-2042054]You can specify a single IP address or hostname.
 
    [bookmark: pgfId-2042062]Community String
 
    [bookmark: pgfId-2042064]The community name.
 
   
 
   [bookmark: pgfId-1872705][bookmark: 23758]SNMP v3 Options
 
   [bookmark: pgfId-2041790]For SNMP v3, you can specify the options described in the following table.
 
    
     
   
 
   
 
   [bookmark: pgfId-2041792]Note When using SNMP v3, the appliance uses an Engine ID value to encode the message. Your SNMP server requires this value to decode the message. Currently, this Engine ID value will always be the hexadecimal version of the appliance’s IP address with 01 at the end of the string. For example, if the appliance sending the SNMP alert has an IP address of 172.16.1.50, the Engine ID is 0xAC10013201 or, if the appliance has an IP address of 10.1.1.77, 0x0a01014D01 is used as the Engine ID.
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-2041836]
 
     
      
       
       [bookmark: pgfId-2041799]Table 44-2 [bookmark: 50665]SNMP v3 Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-2041803]Option 
         
  
        	 
          
          [bookmark: pgfId-2041805]Description 
         
  
       
 
        
        	[bookmark: pgfId-2041807]Trap Type
  
        	[bookmark: pgfId-2041809]The trap type to use for IP addresses that appear in the alerts.
 [bookmark: pgfId-2041810]If your network management system correctly renders the INET_IPV4 address type, then you can select as Binary. Otherwise, select as String. For example, HP Openview requires the string type.
  
       
 
        
        	[bookmark: pgfId-2041812]Trap Server
  
        	[bookmark: pgfId-2041814]The server that will receive SNMP traps notification.
 [bookmark: pgfId-2041815]You can specify a single IP address or hostname.
  
       
 
        
        	[bookmark: pgfId-2041823]Authentication Password
  
        	[bookmark: pgfId-2041825]The password required for authentication. SNMP v3 uses either the Message Digest 5 (MD5) hash function or the Secure Hash Algorithm (SHA) hash function to encrypt this password, depending on configuration.
 [bookmark: pgfId-2041826]If you specify an authentication password, authentication is enabled.
  
       
 
        
        	[bookmark: pgfId-2041828]Private Password
  
        	[bookmark: pgfId-2041830]The SNMP key for privacy. SNMP v3 uses the Data Encryption Standard (DES) block cipher to encrypt this password.
 [bookmark: pgfId-2041831]If you specify a private password, privacy is enabled. If you specify a private password, you must also specify an authentication password.
  
       
 
        
        	[bookmark: pgfId-2041833]User Name
  
        	[bookmark: pgfId-2041835]Your SNMP user name.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-2025178]For information about configuring SNMP Alerting, see Configuring SNMP Responses.
 
   
 
    
     [bookmark: pgfId-2025184][bookmark: 85777]Config[bookmark: marker-2025182]uring SNMP Responses
 
    [bookmark: pgfId-2007402]License: Protection
 
    [bookmark: pgfId-2042150]You can configure SNMP alerting in an intrusion policy. After you apply the policy as part of an access control policy, the system notifies you of any intrusion events it detects via SNMP trap. For more details on SNMP alerting, see Using SNMP Responses.
 
    [bookmark: pgfId-2042158]To configure SNMP alerting options:
 
    [bookmark: pgfId-2013212]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-2007444]Step 1 Select Policies> Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1956471]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1956484]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1898720]The Policy Information page appears.
 
    [bookmark: pgfId-1940546]Step 3 Click Advanced Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1940547]The Advanced Settings page appears.
 
    [bookmark: pgfId-1940548]Step 4 You have two choices, depending on whether SNMP Alerting under External Responses is enabled:
 
     
      
      	 [bookmark: pgfId-1940549]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1940550]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1879665]The SNMP Alerting page appears.
 
    [bookmark: pgfId-2007512]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-1872793]Step 5 Specify the trap type format that you want to use for IP addresses that appear in the alerts, as Binary or as String.
 
     
      
    
 
    
 
    [bookmark: pgfId-1872794]Note If your network management system correctly renders the INET_IPV4 address type, then you can use the as Binary option. Otherwise, use the as String option. For example, HP OpenView requires the as String option.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1872795]Step 6 Select either SNMP v2 or SNMP v3:
 
     
      
      	 [bookmark: pgfId-1872796]To configure SNMP v2, enter the IP address and the community name of the trap server you want to use in the corresponding fields. See SNMP v2 Options.
 
      	 [bookmark: pgfId-2042267]To configure SNMP v3, enter the IP address of the trap server you want to use, an authentication password, a private password, and a user name in the corresponding fields. See SNMP v3 Options for more information.
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2042271]Note You must select SNMP v2 or SNMP v3.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2042272]Note When you enter an SNMP v3 password, the password displays in plain text during initial configuration but is saved in encrypted format.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2076139]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-2072561]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1653690][bookmark: 34839]Using Syslog[bookmark: marker-1653689] Responses
 
    [bookmark: pgfId-2007575]License: Protection
 
    [bookmark: pgfId-1052269]The system log, or syslog, is the standard logging mechanism for network event logging. You can send syslog alerts, which are intrusion event notifications, to the syslog on an appliance. The syslog allows you to categorize information in the syslog by priority and facility. The priority reflects the severity of the alert and the facility indicates the subsystem that generated the alert. Facilities and priorities are not displayed in the actual message that appears in syslog, but are instead used to tell the system that receives the syslog message how to categorize it.
 
    [bookmark: pgfId-1592301]Syslog alerts contain the following information:
 
     
     	 [bookmark: pgfId-1592302]date and time of alert generation
 
     	 [bookmark: pgfId-1592303]event message
 
     	 [bookmark: pgfId-1592304]event data
 
     	 [bookmark: pgfId-1592305]generator ID of the triggering event
 
     	 [bookmark: pgfId-1592306]Snort ID of the triggering event
 
     	 [bookmark: pgfId-1592307]revision
 
    
 
    [bookmark: pgfId-1592040]In an intrusion policy, you can turn on syslog alerting and specify the syslog priority and facility associated with intrusion event notifications in the syslog. When you apply the intrusion policy as part of an access control policy, the system then sends syslog alerts for the intrusion events it detects to the syslog facility on the local host or on the logging host specified in the policy. The host receiving the alerts uses the facility and priority information you set when configuring syslog alerting to categorize the alerts.
 
     
     [bookmark: pgfId-1239728]Facility 
    
 
     
     [bookmark: pgfId-1239730]Description 
    
 
    [bookmark: pgfId-1877269]AUTH
 
    [bookmark: pgfId-1877271]A message associated with security and authorization.
 
    [bookmark: pgfId-1877289]AUTHPRIV
 
    [bookmark: pgfId-1877291]A restricted access message associated with security and authorization. On many systems, these messages are forwarded to a secure file.
 
    [bookmark: pgfId-1877309]CRON
 
    [bookmark: pgfId-1877311]A message generated by the clock daemon.
 
    [bookmark: pgfId-1877329]DAEMON
 
    [bookmark: pgfId-1877331]A message generated by a system daemon.
 
    [bookmark: pgfId-1877349]FTP
 
    [bookmark: pgfId-1877351]A message generated by the FTP daemon.
 
    [bookmark: pgfId-1239732]KERN
 
    [bookmark: pgfId-1239734]A message generated by the kernel. On many systems, these messages are printed to the console when they appear.
 
    [bookmark: pgfId-1877369]LOCAL0-LOCAL7
 
    [bookmark: pgfId-1877371]A message generated by an internal process.
 
    [bookmark: pgfId-1877389]LPR
 
    [bookmark: pgfId-1877391]A message generated by the printing subsystem.
 
    [bookmark: pgfId-1239740]MAIL
 
    [bookmark: pgfId-1239742]A message generated by a mail system.
 
    [bookmark: pgfId-1877409]NEWS
 
    [bookmark: pgfId-1877411]A message generated by the network news subsystem.
 
    [bookmark: pgfId-1239752]SYSLOG
 
    [bookmark: pgfId-1239754]A message generated by the syslog daemon.
 
    [bookmark: pgfId-1877429]USER
 
    [bookmark: pgfId-1877431]A message generated by a user-level process.
 
    [bookmark: pgfId-1239764]UUCP
 
    [bookmark: pgfId-1239766]A message generated by the UUCP subsystem.
 
   
 
    
    [bookmark: pgfId-1877523]Level 
   
 
    
    [bookmark: pgfId-1877525]Description 
   
 
   [bookmark: pgfId-1877527]EMERG 
 
   [bookmark: pgfId-1877529]A panic condition broadcast to all users
 
   [bookmark: pgfId-1877531]ALERT
 
   [bookmark: pgfId-1877533]A condition that should be corrected immediately
 
   [bookmark: pgfId-1877535]CRIT
 
   [bookmark: pgfId-1877537]A critical condition
 
   [bookmark: pgfId-1877539]ERR
 
   [bookmark: pgfId-1877541]An error condition
 
   [bookmark: pgfId-1877543]WARNING
 
   [bookmark: pgfId-1877545]Warning messages
 
   [bookmark: pgfId-1877547]NOTICE
 
   [bookmark: pgfId-1877549]Conditions that are not error conditions, but require attention
 
   [bookmark: pgfId-1877551]INFO
 
   [bookmark: pgfId-1877553]Informational messages
 
   [bookmark: pgfId-1877555]DEBUG
 
   [bookmark: pgfId-1877557]Messages that contain debug information
 
   [bookmark: pgfId-1592279]For more detailed information about how syslog works and how to configure it, refer to the documentation that accompanies your system. If you are logging to a UNIX- or Linux-based system’s syslog, the syslog.conf man file (type man syslog.conf at the command line) and syslog man file (type man syslog at the command line) provide information about how syslog works and how to configure it.
 
    
     [bookmark: pgfId-1483625][bookmark: 35015]Configur[bookmark: marker-1483624]ing Syslog Responses
 
    [bookmark: pgfId-2007609]License: Protection
 
    [bookmark: pgfId-1583672]You can configure syslog alerting in an intrusion policy. After you apply the policy as part of an access control policy, the system notifies you of any intrusion events it detects via the syslog. For more information on syslog alerting, see Using Syslog Responses.
 
    [bookmark: pgfId-1483626]To configure syslog alerting options:
 
    [bookmark: pgfId-2013225]Access: Admin/Intrusion Admin
 
    
 
    [bookmark: pgfId-2007651]Step 1 Select Policies > Intrusion > Intrusion Policy.
 
    [bookmark: pgfId-1956538]The Intrusion Policy page appears.
 ) next to the policy you want to edit. 
    
 
    [bookmark: pgfId-1956551]If you have unsaved changes in another policy, click OK to discard those changes and continue. See Resolving Conflicts and Committing Policy Changes for information on saving unsaved changes in another policy.
 
    [bookmark: pgfId-1898733]The Policy Information page appears.
 
    [bookmark: pgfId-1940621]Step 3 Click Advanced Settings in the navigation panel on the left.
 
    [bookmark: pgfId-1940622]The Advanced Settings page appears.
 
    [bookmark: pgfId-1940623]Step 4 You have two choices, depending on whether Syslog Alerting under External Responses is enabled:
 
     
      
      	 [bookmark: pgfId-1940624]If the configuration is enabled, click  Edit .
 
      	 [bookmark: pgfId-1940625]If the configuration is disabled, click  Enabled , then click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1880884]The Syslog Alerting page appears.
 
    [bookmark: pgfId-2007719]A message at the bottom of the page identifies the intrusion policy layer that contains the configuration. See Using Layers in a Network Analysis or Intrusion Policy for more information.
 
    [bookmark: pgfId-2030590]Step 5 Optionally, in the Logging Hosts field, enter the remote access IP address you want to specify as logging host. Separate multiple hosts with commas.
 
    [bookmark: pgfId-2030592]Step 6 Select facility and priority levels from the drop-down lists.
 
    [bookmark: pgfId-1067364]See Using Syslog Responses for details on facility and priority options.
 
    [bookmark: pgfId-2076155]Step 7 Save your policy, continue editing, discard your changes, revert to the default configuration settings in the base policy, or exit while leaving your changes in the system cache. See Resolving Conflicts and Committing Policy Changes for more information.
 
    [bookmark: pgfId-2072575]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1874315][bookmark: 58493]Understanding Em[bookmark: marker-1874314]ail Alerting
 
    [bookmark: pgfId-2007782]License: Protection
 
    [bookmark: pgfId-1874329]Email alerts are notifications of intrusion events by email. Email alerts include the following information:
 
     
     	 [bookmark: pgfId-1874330]total number of alerts in the database
 
     	 [bookmark: pgfId-1874331]last email time (the time that the system generated the last email report)
 
     	 [bookmark: pgfId-1874332]current time (the time that the system generated the current email report)
 
     	 [bookmark: pgfId-1874333]total number of new alerts
 
     	 [bookmark: pgfId-1874334]number of events that matched specified email filters (if events are configured for specific rules)
 
     	 [bookmark: pgfId-1874335]timestamp, protocol, event message, and session information (source and destination IPs and ports with traffic direction) for each event (if Summary Output is off)
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1874336]Note If multiple intrusion events originate from the same source IP, a note appears beneath the event that displays the number of additional events.
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-1874337]number of events per destination port 
 
     	 [bookmark: pgfId-1874338]number of events per source IP
 
    
 
    [bookmark: pgfId-1874339]For each rule or rule group, you can enable or disable email alerting on intrusion events. Your email alert settings are used regardless of which intrusion policy you apply to the device as part of an access control policy. 
 
    [bookmark: pgfId-1874343]The following list describes the parameters you can set for email alerting.
 
    [bookmark: pgfId-2042512]On/Off
 
    [bookmark: pgfId-2042524]Enables or disables email notification.
 
    [bookmark: pgfId-2042592]From Address
 
    [bookmark: pgfId-2042611]Specifies the email address or addresses from which the system sends intrusion events.
 
    [bookmark: pgfId-2042700]To Address
 
    [bookmark: pgfId-2042712]Specifies the email address where the system sends intrusion events. To send email to multiple recipients, separate email addresses with commas. For example:
 
     
     [bookmark: pgfId-2042878] user1@example.com, user2@example.com 
    
 
    [bookmark: pgfId-2042875]Max Alerts
 
    [bookmark: pgfId-2042905]Specifies the maximum number of intrusion events the system sends via email in the time frame specified by Frequency (seconds).
 
    [bookmark: pgfId-2043037]Frequency (seconds)
 
    [bookmark: pgfId-2043084]Specifies how often the system mails intrusion events. The Frequency setting also specifies the frequency with which email settings are saved.
 
    [bookmark: pgfId-2043095]Minimum frequency: 300 seconds 
Maximum frequency: 4 billion seconds
 
    [bookmark: pgfId-2043078]Coalesce Alerts
 
    [bookmark: pgfId-2043121]Enables or disables grouping of intrusion events by source IP and event so that multiple identical intrusion events generated against the same source IP only present one event on the page. 
 
    [bookmark: pgfId-2043122]Note that alert coalescence (grouping) occurs after events are filtered. Therefore, if you configure email alerting on specific rules, you will only receive a list of events that match the rules you specified in the Mail Alerting Configuration.
 
    [bookmark: pgfId-2043177]Summary Output
 
    [bookmark: pgfId-2043208]Enables or disables brief email alerting, which is suitable for text-limited devices such as pagers. Brief email alerts contain:
 
    [bookmark: pgfId-2043209] – event timestamp 
 
    [bookmark: pgfId-2043213] – for Defense Centers, the IP address for the device that generated the event
 
    [bookmark: pgfId-2043214] – event protocol
 
    [bookmark: pgfId-2043215] – source IP and port
 
    [bookmark: pgfId-2043216] – destination IP and port
 
    [bookmark: pgfId-2043217] – event message 
 
    [bookmark: pgfId-2043218] – the number of intrusion events generated against the same source IP
 
    [bookmark: pgfId-2043219]For example:
 
     
     [bookmark: pgfId-2043220] 2011-05-18 10:35:10 10.1.1.100 icmp 10.10.10.1:8 -> 10.2.1.3:0
 snort_decoder: Unknown Datagram decoding problem! (116:108) 
    
 
    [bookmark: pgfId-2043200]Email Alerting on Specific Rules Configuration
 
    [bookmark: pgfId-2043347]Specifies the rules or rule groups whose events you want mailed to the specified email address or addresses.
 
    [bookmark: pgfId-1874412]For information about configuring email alerting, see Configuring Email Alerting.
 
     
      [bookmark: pgfId-1874433][bookmark: 93194]Configuring Em[bookmark: marker-1874432]ail Alerting
 
     [bookmark: pgfId-2007816]License: Protection
 
     [bookmark: pgfId-1874448]You can configure email alerting so that your appliance notifies you whenever an intrusion event occurs for an specific rule or rule group. 
 
     [bookmark: pgfId-1874449]Before you can receive email alerts, you must:
 
      
      	 [bookmark: pgfId-2007839]configure your mail host to receive email alerts (see Configuring a Mail Relay Host and Notification Address)
 
      	 [bookmark: pgfId-1874457]make sure that both the managed device and the Defense Center can reverse resolve their own IP addresses
 
     
 
     [bookmark: pgfId-1874458]To configure email alerting options:
 
     [bookmark: pgfId-2013243]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-2012954]Step 1 Select Policies > Intrusion > Email.
 
     [bookmark: pgfId-2012955]The Email Alerting page appears.
 
     [bookmark: pgfId-1874469]Step 2 Next to State, select on to enable email alerting.
 
     [bookmark: pgfId-1874470]Step 3 In the From Address field, type the address you want to display in the From field in the email alerts.
 
     [bookmark: pgfId-1874471]Step 4 In the To Address field, type the address where you want to receive the email alerts.
 
     [bookmark: pgfId-1874472]Step 5 In the Max Alerts field, type the maximum number of events you want included in a single email.
 
     [bookmark: pgfId-1874473]Step 6 In the Min Frequency field, type the number of seconds for the minimum frequency with which you want to receive email alerts.
 
     [bookmark: pgfId-1874474]Step 7 To group events by IP address, next to Coalesce Alerts, select on.
 
     [bookmark: pgfId-1874475]Step 8 To send brief email alerts, next to Summary Output, select on.
 
      
       
     
 
     
 
     [bookmark: pgfId-1874476]Tip If you enable Summary Output, consider enabling Coalesce Alerts to reduce the number of alerts generated. Also consider setting Max Alerts to 1 to avoid overflowing your device’s text message buffer.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1874477]Step 9 In the Time Zone field, select your time zone from the drop-down list.
 
     [bookmark: pgfId-1981382]Step 10 To enable email alerting per rule, click Email Alerting per Rule Configuration.
 
     [bookmark: pgfId-1874478]The rule groups appear.
 
      
       
     
 
     
 
     [bookmark: pgfId-1874479]Tip To receive email alerts for all rules in all categories, select Select All.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1874480]Step 11 Perform one or both of the following:
 
      
       
       	 [bookmark: pgfId-1874481]Click  All next to rule categories for which you want to receive email alerts for all rules belonging to the category.
 
       	 [bookmark: pgfId-1874482]Click the category folder within which you want to specify email alerting on individual rules in that category, then enable the rules for which you want to receive email alerts.
 
      
 
     
 
     [bookmark: pgfId-1874490]Step 12 Click Save.
 
     [bookmark: pgfId-2017834]The system saves your email alerting configuration. When applicable intrusion events occur, you receive email alerts.
 
     [bookmark: pgfId-2072657]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1597654]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1533842][bookmark: 25251]Introduction to Netw[bookmark: marker-1533841]ork Discovery 
      
      
 
     
 
 
    [bookmark: pgfId-1533846]The FireSIGHT System uses a feature called network discovery to monitor traffic on your network and build a comprehensive map of your network assets.
 
    [bookmark: pgfId-1533847]As managed devices passively observe traffic on the network segments you specify, the system compares specific packet header values and other unique data from network traffic against established definitions (called fingerprints) to determine the number and types of hosts (including network devices) on your network, as well as the operating systems, active applications, and open ports on those hosts.
 
    [bookmark: pgfId-1533851]You can also configure FireSIGHT System managed devices to monitor user activity on your network, which allows you to identify the source of policy breaches, attacks, or network vulnerabilities.
 
    [bookmark: pgfId-1533852]To supplement the data gathered by the system, you can import records generated by NetFlow-enabled devices, Nmap active scans, the host input feature, and User Agents that reside on a Microsoft Active Directory server and report LDAP authentications. The FireSIGHT System integrates these records with the information it collects via direct network traffic observation by managed devices.
 
    [bookmark: pgfId-1533862]The system can correlate certain types of intrusion, malware, and other events occurring on hosts on your network to determine when hosts are potentially compromised, tagging those hosts with indications of compromise (IOC) tags. IOC data can give you a clear, direct picture of the threats to your monitored network as they relate to its hosts.
 
    [bookmark: pgfId-1533863]The system uses all of this information to help you with forensic analysis, behavioral profiling, access control, and mitigating and responding to the vulnerabilities and exploits to which your organization is susceptible.
 
    [bookmark: pgfId-1533865]For more information, see:
 
     
     	 [bookmark: pgfId-1533869]Understanding Discovery Data Collection
 
     	 [bookmark: pgfId-1533873]Understanding NetFlow
 
     	 [bookmark: pgfId-1533877]Understanding Indications of Compromise
 
     	 [bookmark: pgfId-1533881]Creating a Network Discovery Policy
 
    
 
   
 
    
     [bookmark: pgfId-1538680][bookmark: 45795][bookmark: 80317]Understanding Discovery Data Col[bookmark: marker-1538679]lection
 
    [bookmark: pgfId-1538687]License: FireSIGHT
 
    [bookmark: pgfId-1538688]Discovery data includes information on your network’s hosts and the operating systems, active applications, and user activity on those hosts.
 
    [bookmark: pgfId-1533895]To begin collecting discovery data, you must first apply an access control policy. The access control policy defines the traffic that you permit, and therefore the traffic you can monitor with network discovery. Note that this means if you block certain traffic using access control, the system cannot examine that traffic for host, user, or application activity. For example, if you block access to social networking applications, the system does not provide you with any discovery data on social network applications.
 
    [bookmark: pgfId-1533899]After you apply an access control policy, you must configure and apply a network discovery policy, which specifies the network segments and ports you want to monitor with your managed devices, and the kinds of data you want to collect. When you apply the network discovery policy, the system begins generating discovery data, which you can then view and analyze using the Defense Center web interface.
 
    [bookmark: pgfId-1533906]The system stores network discovery data in the Defense Center database; for information on storage limits, see Configuring Database Event Limits. In addition to the database limits, the total number of detected hosts and users the Defense Center can store depends on your FireSIGHT license. 
 
    [bookmark: pgfId-1533916]After you reach the licensed user limit, in most cases, the system stops adding new users to the database. To add new users, you must either manually delete old or inactive users from the database, or purge all users from the database. On the other hand, after you reach the licensed host limit, you can configure the system either to stop adding new hosts to the database, or to replace the hosts that have remained inactive for the longest time.
 
    [bookmark: pgfId-1533917]To supplement the data gathered by the system, you can import records generated by NetFlow-enabled devices, Nmap active scans, the host input feature, and User Agents that reside on a Microsoft Active Directory server and report LDAP authentications. The FireSIGHT System integrates these records with the information it collects via direct network traffic observation by managed devices.
 
    [bookmark: pgfId-1533927]For more information, see:
 
     
     	 [bookmark: pgfId-1533931]Understanding Host Data Collection
 
     	 [bookmark: pgfId-1533935]Understanding User Data Collection
 
     	 [bookmark: pgfId-1533939]Understanding Application Detection
 
     	 [bookmark: pgfId-1533943]Understanding Indications of Compromise
 
     	 [bookmark: pgfId-1533947]Importing Third-Party Discovery Data
 
     	 [bookmark: pgfId-1533951]Uses for Discovery Data
 
    
 
     
      [bookmark: pgfId-1533954][bookmark: 71415]Understanding Host Data Coll[bookmark: marker-1533953]ection
 
     [bookmark: pgfId-1533958]License: FireSIGHT
 
     [bookmark: pgfId-1533959]As the system passively monitors the traffic that travels through your network, it compares specific packet header values and other unique data from network traffic against established definitions (called fingerprints) to determine the following information about the hosts on your network, including:
 
      
      	 [bookmark: pgfId-1533960]the number and types of hosts (including network devices such as bridges, routers, load balancers, and NAT devices)
 
      	 [bookmark: pgfId-1533961]basic network topology data, including the number of hops from the discovery point on the network to the hosts
 
      	 [bookmark: pgfId-1533962]the operating systems running on the hosts
 
      	 [bookmark: pgfId-1560356]applications on the hosts and users associated with these applications
 
     
 
     [bookmark: pgfId-1533963]If the system cannot identify the operating system of a host, you can use the custom fingerprinting feature to create custom client or server fingerprints. The system uses these fingerprints to identify new hosts. You can map fingerprints to systems in the vulnerability database (VDB) to allow the appropriate vulnerability information to be displayed whenever a host is identified using the custom fingerprint. For more information, see Using Custom Fingerprinting.
 
     [bookmark: pgfId-1533967]You can also add or update host and operating system data through the host input feature. In addition, if you create a NetFlow-enabled discovery rule with host detection enabled, hosts can be added to the network map from NetFlow data.
 
     [bookmark: pgfId-1533971]You can view the hosts detected by the system using the Defense Center web interface:
 
      
      	 [bookmark: pgfId-1533972]For information on viewing and searching for hosts using the event viewer, see Working with Hosts.
 
      	 [bookmark: pgfId-1533976]For information on viewing the network map, which is a detailed representation of your network assets and topology, see Using the Network Map.
 
      	 [bookmark: pgfId-1533980]For information on viewing host profiles, which are complete views of all the information available for your detected hosts, see Using Host Profiles.
 
     
 
    
 
     
      [bookmark: pgfId-1533986][bookmark: 28912]Understanding User Data Co[bookmark: marker-1533985]llection
 
     [bookmark: pgfId-1533990]License: FireSIGHT
 
     [bookmark: pgfId-1533994]You can use the FireSIGHT System to monitor user activity on your network, which allows you to correlate threat, endpoint, and network intelligence with user identity information. By linking network behavior, traffic, and events directly to individual users, the system can help you to identify the source of policy breaches, attacks, or network vulnerabilities. In other words, the system can tell you the “who” behind the “what.” For example, you could determine:
 
      
      	 [bookmark: pgfId-1533995]who owns the host targeted by an intrusion event that has a Vulnerable (level 1: red) impact level
 
      	 [bookmark: pgfId-1533996]who initiated an internal attack or portscan
 
      	 [bookmark: pgfId-1533997]who is attempting unauthorized access of a server that has high host criticality
 
      	 [bookmark: pgfId-1533998]who is consuming an unreasonable amount of bandwidth
 
      	 [bookmark: pgfId-1533999]who has not applied critical operating system updates 
 
      	 [bookmark: pgfId-1534000]who is using instant messaging software or peer-to-peer file-sharing applications in violation of company IT policy
 
     
 
     [bookmark: pgfId-1534001]Armed with this information, you can take a targeted approach to mitigate risk, block users or user activity, and take action to protect others from disruption. These capabilities also significantly improve audit controls and enhance regulatory compliance.
 
     [bookmark: pgfId-1534002]The system downloads the users used in access control policies from the Microsoft Active Directory LDAP server, based on the user awareness settings in the LDAP connection. The User Agent then provides login data for these users and the users are added to the user database. These users are referred to as access-controlled users. When you author access control policies that include user conditions, you write those conditions against access-controlled users. For more information, see Adding a User Condition to an Access Control Rule.
 
     [bookmark: pgfId-1534012]When the system detects user data from a user login, either from a User Agent, from application data detected in traffic, or from an email login over POP3, SMTP, or IMAP, the user from the login is checked against the list of users. If the login user matches an existing user reported by an agent, the data from the login is assigned to the user. Logins that do not match existing users cause a new user to be created, unless the login is in SMTP traffic. Non-matching logins in SMTP traffic are discarded.
 
     [bookmark: pgfId-1534017]The following diagram illustrates how the FireSIGHT System collects and stores user data.
 
     [bookmark: pgfId-1605390]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1534023]As shown in the diagram, there are three sources for user data, and three places that data is stored. For more information on user data collection, see:
 
      
      	 [bookmark: pgfId-1534027]Managed Devices
 
      	 [bookmark: pgfId-1534031]User Agents
 
      	 [bookmark: pgfId-1534035]Defense Center-LDAP Server Connections
 
      	 [bookmark: pgfId-1534039]Users Database
 
      	 [bookmark: pgfId-1534043]User Activity Database
 
      	 [bookmark: pgfId-1534047]Access-Controlled Users Database
 
      	 [bookmark: pgfId-1534051]User Data Collection Limitations
 
     
 
    
 
     
      [bookmark: pgfId-1534053][bookmark: 81841]Managed Devices
 
     [bookmark: pgfId-1534057]License: FireSIGHT
 
     [bookmark: pgfId-1534058]You use the network discovery policy to configure managed devices to passively detect LDAP, AIM, POP3, IMAP, Oracle, SIP (VoIP), FTP, HTTP, MDNS, and SMTP logins on the networks you specify. Note that when you enable discovery of users in a network discovery rule, host discovery is automatically enabled.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534059]Note Managed devices interpret only Kerberos logins for LDAP connections as LDAP authentications. Managed devices cannot detect encrypted LDAP authentications using protocols such as SSL or TLS.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534062]When a device detects a login, it sends the following information to the Defense Center to be logged as user activity:
 
      
      	 [bookmark: pgfId-1534064]the user name identified in the login
 
      	 [bookmark: pgfId-1534065]the time of the login
 
      	 [bookmark: pgfId-1534066]the IP address involved in the login, which can be the IP address of the user’s host (for LDAP, POP3, IMAP, and AIM logins), the server (for HTTP, MDNS, FTP, SMTP and Oracle logins), or the session originator (for SIP logins)
 
      	 [bookmark: pgfId-1534067]the user’s email address (for POP3, IMAP, and SMTP logins)
 
      	 [bookmark: pgfId-1534068]the name of the device that detected the login
 
     
 
     [bookmark: pgfId-1534072]If the user was previously detected, the Defense Center updates that user’s login history. Note that the Defense Center can use the email addresses in POP3 and IMAP logins to correlate with LDAP users. This means that, for example, if the Defense Center detects a new IMAP login, and the email address in the IMAP login matches that for an existing LDAP user, the IMAP login does not create a new user, rather, it updates the LDAP user’s history.
 
     [bookmark: pgfId-1534082]If the user has never been detected before, the Defense Center adds the user to the users database. Unique AIM, SIP, and Oracle logins always create new user records, because there is no data in those login events that the Defense Center can correlate with other login types.
 
     [bookmark: pgfId-1534089]The Defense Center does not log user activity or user identities in the following cases:
 
      
      	 [bookmark: pgfId-1534090]if you configured the network discovery policy to ignore that login type, as described in Restricting User Logging
 
      	 [bookmark: pgfId-1534094]if a managed device detects an SMTP login, but the users database does not contain a previously detected LDAP, POP3, or IMAP user with a matching email address
 
     
 
    
 
     
      [bookmark: pgfId-1534100][bookmark: 11297]User Ag[bookmark: marker-1534099]ents
 
     [bookmark: pgfId-1534104]License: FireSIGHT
 
     [bookmark: pgfId-1534109]If your organization uses Microsoft Active Directory LDAP servers, Cisco recommends that you install User Agents to monitor user activity via your Active Directory servers. If you want to perform user control, you must install and use User Agents; the agents associate users with IP addresses, which in turn allows access control rules with user conditions to trigger. You can use one agent to monitor user activity on up to five Active Directory servers. 
 
     [bookmark: pgfId-1534119]To use an agent, you must configure a connection between each Defense Center connected to the agent and the monitored LDAP servers. This connection not only allows you to retrieve metadata for the users whose logins and logoffs were detected by User Agents, but also is used to specify the users and groups you want to use in access control rules. For more information on configuring LDAP servers for user discovery, see Retrieving Access-Controlled Users and LDAP User Metadata.
 
     [bookmark: pgfId-1534123]Each agent can monitor logins using encrypted traffic, either through regularly scheduled polling or real-time monitoring. Logins are generated by the Active Directory server when a user logs into a computer, whether at the workstation or through a Remote Desktop login. 
 
     [bookmark: pgfId-1534124]Agents can also monitor and report user logoffs. Logoffs are generated by the agent itself when it detects a user logged out of a host IP address. Logoffs are also generated when the agent detects that the user logged into a host has changed, before the Active Directory server reports that the user has changed. Combining logoff data with login data develops a more complete view of the users logged into the network. 
 
     [bookmark: pgfId-1534125]Polling an Active Directory server allows an agent to retrieve batches of user activity data at the defined polling interval. Real-time monitoring transmits user activity data to the agent as soon as the Active Directory server receives the data. 
 
     [bookmark: pgfId-1534126]You can configure the agent to exclude reporting any logins or logoffs associated with a specific user name or IP address. This can be useful, for example, to exclude repeated logins to shared servers, such as file shares and print servers, as well as exclude users logging into machines for troubleshooting purposes. 
 
     [bookmark: pgfId-1534127]The agents send records of all detected logins and logoffs that do not contain an excluded user name or IP address to Defense Centers, which log and report them as user activity. The agents detect the Defense Center version and send the login records in the appropriate data format. This supplements any user activity detected directly by managed devices. The logins reported by User Agents associate users with IP addresses, which in turn allows access control rules with user conditions to trigger.
 
     [bookmark: pgfId-1534134]User Agents monitor users as they log into the network or when accounts authenticate against Active Directory credentials for other reasons. Version 2.1 of the User Agent detects interactive user logins to a host, Remote Desktop logins, file-share authentication, and computer account logins, as well as user logoffs and Remote Desktop sessions where the user has logged off.
 
     [bookmark: pgfId-1534138]The type of login detected determines how the agent reports the login and how the login appears in the host profile. An authoritative user login[bookmark: marker-1534139] for a host causes the current user mapped to the host IP address to change to the user from the new login. Other logins either do not change the current user or only change the current user for the host if the existing user on the host did not have an authoritative user login to the host. In these cases, if the expected user is no longer logged in, the agent generates a logoff for that user. User logins detected by network discovery only change the current user for the host if the existing user on the host did not have an authoritative user login to the host. Agent-detected logins have the following effect on the network map:
 
      
      	 [bookmark: pgfId-1534140]When the agent detects an interactive login to a host by a user or a Remote Desktop login, the agent reports an authoritative user login for the host and changes the current user for the host to the new user.
 
      	 [bookmark: pgfId-1534141]If the agent detects a login for file-share authentication, the agent reports a user login for the host, but does not change the current user on the host. 
 
      	 [bookmark: pgfId-1534142]If the agent detects a computer account login to a host, the agent generates a NetBIOS Name Change discovery event and the host profile reflects any change to the NetBIOS name.
 
      	 [bookmark: pgfId-1534143]If the agent detects a login from an excluded user name, the agent does not report a login to the Defense Center.
 
     
 
     [bookmark: pgfId-1534147]When a login or other authentication occurs, the agent sends the following information to the Defense Center:
 
      
      	 [bookmark: pgfId-1534151]the user’s LDAP user name 
 
      	 [bookmark: pgfId-1534152]the time of the login or other authentication
 
      	 [bookmark: pgfId-1534153]the IP address of the user’s host, and the link-local address if the agent reports an IPv6 address for a computer account login
 
     
 
     [bookmark: pgfId-1534157]The Defense Center records login and logoff information as user activity. When a User Agent reports user data from a user login or logoff, the reported user is checked against the list of users. If the reported user matches an existing user reported by an agent, the reported data is assigned to the user. Reported users that do not match existing users cause a new user to be created. 
 
     [bookmark: pgfId-1534161]Even though the user activity associated with an excluded user name is not reported, related user activity may still be reported. If the agent detects a user login to a machine, then the agent detects a second user login, and you have excluded the user name associated with the second user login from reporting, the agent reports a logoff for the original user. However, no login for the second user is reported. As a result, no user is mapped to the IP address, even though the excluded user is logged into the host.
 
     [bookmark: pgfId-1534162]Note the following limitations on user names detected by the agent:
 
      
      	 [bookmark: pgfId-1534163]User names ending with a dollar sign character ( $ ) reported to the Defense Center update the network map, but do not appear as user logins.
 
      	 [bookmark: pgfId-1534173]Defense Center display of user names containing Unicode characters may have limitations. 
 
     
 
     [bookmark: pgfId-1534177]The total number of detected users the Defense Center can store depends on your FireSIGHT license. After you reach the licensed user limit, in most cases the system stops adding new users to the database. To add new users, you must either manually delete old or inactive users from the database, or purge all users from the database. 
 
    
 
     
      [bookmark: pgfId-1534202][bookmark: 62654]Defense Center-LDAP Server Connections
 
     [bookmark: pgfId-1534206]License: FireSIGHT
 
     [bookmark: pgfId-1534210]The Defense Center-LDAP server connection allows you to retrieve metadata for certain detected users. You can retrieve metadata for LDAP users, whether their logins were detected by managed devices or by a User Agent; you can also retrieve metadata for POP3 and IMAP users if those users have the same email address as an LDAP user. 
 
     [bookmark: pgfId-1534211]If your organization uses Microsoft Active Directory servers, the connection also allows you to specify the [bookmark: marker-1534212]LDAP users and groups you want to use in access control rules. If you want to perform user control, you must configure a connection between the Defense Center and an Active Directory server. If your organization does not use Active Directory, you can still detect user logins using managed devices, and you can still obtain metadata for some of those users from an Oracle or OpenLDAP server. However, you cannot perform user control based on those users or their activity.
 
     [bookmark: pgfId-1534219]From the LDAP server, the Defense Center obtains the following information and metadata about each user:
 
      
      	 [bookmark: pgfId-1534220]LDAP user name
 
      	 [bookmark: pgfId-1534221]first and last names
 
      	 [bookmark: pgfId-1534222]email address
 
      	 [bookmark: pgfId-1534223]department
 
      	 [bookmark: pgfId-1534224]telephone number
 
     
 
    
 
     
      [bookmark: pgfId-1534226][bookmark: 22639]Users Database
 
     [bookmark: pgfId-1534230]License: FireSIGHT
 
     [bookmark: pgfId-1576586]The users database contains a record for each user detected by either managed devices or User Agents. The total number of detected users the Defense Center can store depends on your FireSIGHT license. After you reach the licensed limit, in most cases the system stops adding new users to the database. To add new users, you must either manually delete old or inactive users from the database, or purge all users from the database.
 
     [bookmark: pgfId-1534239]However, the system favors authoritative user logins. If you have reached the limit and the system detects an authoritative user login for a previously undetected user, the system deletes the non-authoritative user who has remained inactive for the longest time, and replaces it with the new user. 
 
     [bookmark: pgfId-1534243]You can view the contents of the users database with the Defense Center web interface. For information on viewing, search for, and deleting detected users, see Working with Users.
 
    
 
     
      [bookmark: pgfId-1534248][bookmark: 12124]User Activity Database
 
     [bookmark: pgfId-1534252]License: FireSIGHT
 
     [bookmark: pgfId-1576589]The user activity database contains records of user activity on your network, either from a connection to an Active Directory LDAP server that is also monitored by a User Agent, or though network discovery. The system logs events in the following circumstances: 
 
      
      	 [bookmark: pgfId-1534258]when it detects individual logins or logoffs
 
      	 [bookmark: pgfId-1534259]when it detects a new user 
 
      	 [bookmark: pgfId-1534260]when you manually delete a user 
 
      	 [bookmark: pgfId-1534261]when the system detects a user that is not in the database, but cannot add the user because you have reached your FireSIGHT licensed limit
 
     
 
     [bookmark: pgfId-1534268]You can view the user activity detected by the system using the Defense Center web interface. For information on viewing, searching for, and deleting user activity, see Working with User Activity. If you plan to use Version 2.1 of the User Agent to send LDAP login data to your Defense Centers, you must configure a connection for each agent on each Defense Center where you want the agent to connect. That connection allows the agent to establish a secure connection with the Defense Center, over which it can send login data. If the agent is configured to exclude specific user names, login data for those user names are not reported to the Defense Center.
 
     [bookmark: pgfId-1534287]In addition, if you are planning to implement user access control, you must set up a connection to each Microsoft Active Directory server where you plan to collect data, with user awareness parameters configured.
 
     [bookmark: pgfId-1534291]Whenever possible the FireSIGHT System correlates user activity with other types of events. For example, intrusion events can tell you the users who were logged into the source and destination hosts at the time of the event.
 
     [bookmark: pgfId-1534292]The system also uses user activity to generate host histories, which track the hosts that each user has logged into, and user histories, which track the users that have logged into each individual host. The system provides a graphical representation of the last twenty-four hours of each user’s activity and the last twenty-four hours of the logins to each host. For more information, see Understanding User Details and Host History and Working with User History in the Host Profile.
 
    
 
     
      [bookmark: pgfId-1534300][bookmark: 68002]Access-Controlled Users Database
 
     [bookmark: pgfId-1534304]License: Control
 
     [bookmark: pgfId-1576600]The [bookmark: marker-1534306]access-controlled users database contains the users and groups that you can use in access control rules, so that you can perform user control with the FireSIGHT System. The[bookmark: marker-1534311]se users can be one of two types:
 
      
      	 [bookmark: pgfId-1534312]An  access-controlled user is a user that you can add to access control rules to perform user control. You specify the groups that access-controlled users must belong to when you configure the Defense Center-LDAP server connection.
 
      	 [bookmark: pgfId-1534317]A  non-access-controlled user [bookmark: marker-1534316] is any other detected user.
 
     
 
     [bookmark: pgfId-1534318]You specify the groups that access-controlled users must belong to when you configure the Defense Center-LDAP server connection, as described in Retrieving Access-Controlled Users and LDAP User Metadata. 
 
     [bookmark: pgfId-1534328]If you plan to use Version 2.1 of the User Agent to send LDAP login and logoff data to your Version 5.x Defense Centers, you must configure a connection for each agent on each Defense Center where you want the agent to connect. That connection allows the agent to establish a secure connection with the Defense Center, over which it can send the user activity data. 
 
     [bookmark: pgfId-1534338]If the agent is configured to exclude specific user names, user activity data for those user names are not reported to the Defense Center. These excluded user names remain in the database, but are not associated with IP addresses.
 
     [bookmark: pgfId-1534342]In addition, if you are planning to implement user access control, you must set up a connection to each Microsoft Active Directory server where you plan to collect data, with user awareness parameters configured.
 
     [bookmark: pgfId-1534343]The maximum number of users you can use in access control depends on your FireSIGHT license. When configuring the Defense Center-LDAP server connection, make sure the total number of users you include is less than your FireSIGHT user license. See Understanding FireSIGHT Host and User License Limits for more information.
 
    
 
     
      [bookmark: pgfId-1534357][bookmark: 44109]User Data Collection Limitations
 
     [bookmark: pgfId-1534361]License: FireSIGHT
 
     [bookmark: pgfId-1576607]The following table describes the limitations of user data collection.
 
     [bookmark: pgfId-1534465]
 
      
       
        
        [bookmark: pgfId-1534370]Table 45-1 [bookmark: 78342]User Awareness Limitations 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534374]Limitation 
          
  
         	 
           
           [bookmark: pgfId-1534376]Description 
          
  
        
 
         
         	[bookmark: pgfId-1534378]user control
  
         	[bookmark: pgfId-1534380]To perform user control, your organization must use Microsoft Active Directory LDAP servers. The system obtains the users and groups you can use in access control rules from Active Directory, and also ties users to IP addresses with the logins and logoffs reported by User Agents installed on Active Directory servers.
  
        
 
         
         	[bookmark: pgfId-1534385]non-Kerberos logins for LDAP connections
  
         	[bookmark: pgfId-1534387]Managed devices interpret only Kerberos logins for LDAP connections as LDAP authentications. Managed devices cannot detect encrypted LDAP authentications if they use other protocols, such as SSL or TLS.
 [bookmark: pgfId-1534391]On the other hand, User Agents use the security logs on Active Directory servers to collect user login data and have no such limitations.
  
        
 
         
         	[bookmark: pgfId-1534393]login detection
  
         	[bookmark: pgfId-1534410]If you want to detect logins to an Active Directory server, you must configure the Active Directory server connection with the server IP address. See the User Agent Configuration Guide for more information.
 [bookmark: pgfId-1534414]If multiple users are logged into a host using remote sessions, the agent may not detect logins from that host properly. See the User Agent Configuration Guide for more information on how to prevent this.
  
        
 
         
         	[bookmark: pgfId-1534419]logoff detection
  
         	[bookmark: pgfId-1534425]Logoffs may not be immediately detected. The timestamp associated with a logoff reflects when the agent detected the user was no longer mapped to the host IP address, which may not correspond to the actual time the user logged off of the host. 
 [bookmark: pgfId-1534426]Logoffs are generated by the agent itself when it detects a user logged out of a host IP address. Logoffs are also generated when the agent detects that the user logged into a host has changed, before the Active Directory server reports that the user has changed.
  
        
 
         
         	[bookmark: pgfId-1534428]real-time data retrieval
  
         	[bookmark: pgfId-1534430]The Active Directory server must be running Windows Server 2008 or Windows Server 2012.
  
        
 
         
         	[bookmark: pgfId-1534432]multiple logins to the same host by different users
  
         	[bookmark: pgfId-1534434]The system assumes that only one user is logged into any given host at a time, and that the current user of a host is the last authoritative user login. If only non-authoritative logins have been logged into the host, the last non-authoritative login is considered the current user. If multiple users are logged in through remote sessions, the last user reported by the Active Directory server is the user reported to the Defense Center.
  
        
 
         
         	[bookmark: pgfId-1534439]multiple logins to the same host by the same user
  
         	[bookmark: pgfId-1534441]The system records the first time that a user logs into a specific host and disregards subsequent logins. If an individual user is the only person who logs into a specific host, the only login that the system records is the original login.
 [bookmark: pgfId-1534442]If another user logs into that host, however, the system records the new login. Then, if the original user logs in again, his or her new login is recorded.
  
        
 
         
         	[bookmark: pgfId-1534444]Unicode characters
  
         	[bookmark: pgfId-1534446]The user interface may not correctly display user names with Unicode characters.
  
        
 
         
         	[bookmark: pgfId-1534452]LDAP user accounts in the users database
  
         	[bookmark: pgfId-1534454]If you remove or disable an LDAP user on your LDAP servers, or exclude the user name from being reported to the Defense Center, the Defense Center does not remove that user from the users database, and that user continues to count against your licensed limit for user listed in the database. You must manually purge the user from the database. 
 [bookmark: pgfId-1576232]Note that the user license limit is applied in parallel for access-controlled users; the user count for access-controlled users depends on the number of users retrieved by your LDAP configuration.
  
        
 
         
         	[bookmark: pgfId-1534462]AOL Instant Messenger (AIM) login detection
  
         	[bookmark: pgfId-1534464]Managed devices can detect AIM logins using the OSCAR protocol only. While most AIM clients use OSCAR, some use TOC2.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1534468][bookmark: 48536]Understanding Applicati[bookmark: marker-1534467]on Detection
 
     [bookmark: pgfId-1534472]License: FireSIGHT
 
     [bookmark: pgfId-1534476]When the FireSIGHT System analyzes IP traffic, it attempts to identify the commonly used applications on your network. Application awareness is crucial to performing application-based access control.
 
     [bookmark: pgfId-1534477]There are three types of applications that the system detects:
 
      
      	 [bookmark: pgfId-1534478] application protocols such as HTTP and SSH, which represent communications between hosts
 
      	 [bookmark: pgfId-1534479] clients such as web browsers and email clients, which represent software running on the host
 
      	 [bookmark: pgfId-1534480] web applications such as MPEG video and Facebook, which represent the content or requested URL for HTTP traffic
 
     
 
     [bookmark: pgfId-1534481]The system identifies applications in your network traffic either using ASCII or hexadecimal patterns in the packet headers, or the port that the traffic uses. Some application detectors use both port and pattern detection to increase the likelihood of correctly identifying traffic for a particular application. In addition, Secure Socket Layers (SSL) protocol detectors use information from the secured session to identify the application from the session. There are two sources of application detectors in the FireSIGHT System:
 
      
      	 [bookmark: pgfId-1534488] Cisco  -provided detectors , which detect web applications, clients, and application protocols
 
     
 
     [bookmark: pgfId-1534492]The availability of Cisco-provided detectors for applications (and operating systems, see Understanding Host Data Collection) depend on the version of the FireSIGHT System and the version of the VDB you have installed. Release notes and advisories contain information on new and updated detectors. You can also import individual detectors authored by Professional Services. For a complete list of detected applications, see the Support site.
 
      
      	 [bookmark: pgfId-1534506] user-defined application protocol detectors , which you can create to enhance the system’s application protocol detection capabilities
 
     
 
     [bookmark: pgfId-1534507]You can also detect application protocols through implied application protocol detection, which implies the existence of an application protocol based on the detection of a client. 
 
     [bookmark: pgfId-1534508]The system characterizes each application that it detects using the criteria described in the following table. The system uses these characteristics to create application filters, or groups of applications. You can use these filters and filters that you create to perform access control, as well as to constrain searches, reports, and dashboard widgets. For more information, see Working with Application Filters.
 
     [bookmark: pgfId-1572777]:
 
      
       
        
        [bookmark: pgfId-1572733]Table 45-2 [bookmark: 89550]Application Characteristics 
 
        
        
         
         	 
           
           [bookmark: pgfId-1572739]Characteristic 
          
  
         	 
           
           [bookmark: pgfId-1572741]Description 
          
  
         	 
           
           [bookmark: pgfId-1572743]Example 
          
  
        
 
         
         	[bookmark: pgfId-1572745]Type
  
         	[bookmark: pgfId-1572747]The type of application:
 
           
           	 [bookmark: pgfId-1572748] Application Protocols represent communications between hosts.
 
           	 [bookmark: pgfId-1572749] Clients represent software running on a host.
 
           	 [bookmark: pgfId-1572750] Web Applications represent the content or requested URL for HTTP traffic.
 
          
  
         	[bookmark: pgfId-1572752]HTTP and SSH are application protocols. Web browsers and email clients are clients.
 [bookmark: pgfId-1576614]MPEG video and Facebook are web applications.
  
        
 
         
         	[bookmark: pgfId-1572754]Risk
  
         	[bookmark: pgfId-1572756]How likely the application is to be used for purposes that might be against your organization’s security policy. An application’s risk can range from Very Low to Very High.
  
         	[bookmark: pgfId-1572758]Peer-to-peer applications tend to have a very high risk.
  
        
 
         
         	[bookmark: pgfId-1572760]Business Relevance
  
         	[bookmark: pgfId-1572762]The likelihood that the application is used within the context of your organization’s business operations, as opposed to recreationally. An application’s business relevance can range from Very Low to Very High.
  
         	[bookmark: pgfId-1572764]Gaming applications tend to have a very low business relevance.
  
        
 
         
         	[bookmark: pgfId-1572766]Category
  
         	[bookmark: pgfId-1572768]A general classification for the application that describes its most essential function. Each application belongs to at least one category.
  
         	[bookmark: pgfId-1572770]Facebook is in the social networking category.
  
        
 
         
         	[bookmark: pgfId-1572772]Tag
  
         	[bookmark: pgfId-1572774]Additional information about the application. Applications can have any number of tags, including none.
  
         	[bookmark: pgfId-1572776]Video streaming web applications often are tagged high bandwidth and displays ads.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1534563]To supplement the application data gathered by the system, you can use records generated by NetFlow-enabled devices, Nmap active scans, and the host input feature.
 
     [bookmark: pgfId-1534567]For more information, see:
 
      
      	 [bookmark: pgfId-1534571]Understanding the Application Protocol Detection Process
 
      	 [bookmark: pgfId-1534575]Implied Application Protocol Detection from Client Detection
 
      	 [bookmark: pgfId-1534578]Special Considerations for Application Protocol Detection: Squid
 
      	 [bookmark: pgfId-1534583]Special Considerations: SSL Application Detection
 
      	 [bookmark: pgfId-1534587]Special Considerations: Referred Web Applications
 
      	 [bookmark: pgfId-1534591]Working with Application Detectors
 
      	 [bookmark: pgfId-1534595]Importing Third-Party Discovery Data
 
      	 [bookmark: pgfId-1534599]Understanding NetFlow
 
     
 
    
 
     
      [bookmark: pgfId-1534601][bookmark: 39020]Understanding the Application Protocol Detection Process
 
     [bookmark: pgfId-1534605]License: FireSIGHT
 
     [bookmark: pgfId-1534606]When the system detects application traffic, it first determines whether the application protocol is running on a port identified by a detector that uses that specific port as its only detection criterion. If the application protocol is running on one of those ports, the system positively identifies the application protocol using the well-known port detector.
 
      
       
     
 
     
 
     [bookmark: pgfId-1534607]Note Because you can create and activate user-defined port-based application protocol detectors on ports used by Cisco-provided detectors, it is possible to override Cisco’s detection capabilities. For example, if your user-defined detector identifies all application protocol traffic on port 22 as the myapplication application protocol, SSH traffic on port 22 will be misidentified as myapplication traffic.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534614]If the application protocol is not running on one of those ports, the system employs a more robust method to identify it based on port and pattern matches. If two detectors both positively identify the traffic, the detector that employs the longer pattern match has precedence. Similarly, detectors with multiple pattern matches have precedence over single pattern matches.
 
     [bookmark: pgfId-1534615]Note that the system identifies only those application protocols running on hosts in your monitored networks, as defined in the network discovery policy. For example, if an internal host accesses an FTP server on a remote site that you are not monitoring, the system does not identify the application protocol as FTP. On the other hand, if a remote or internal host accesses an FTP server on a host you are monitoring, the system can positively identify the application protocol. 
 
     [bookmark: pgfId-1534616]An exception occurs if the system can identify the client used in connections between a monitored host accessing a non-monitored server. In that case, the system positively identifies the appropriate application protocol that corresponds with the client in the connection, but does not add the application protocol to the network map. For more information, see Implied Application Protocol Detection from Client Detection. Note that client sessions must include a response from the server for application detection to occur.
 
     [bookmark: pgfId-1534623]The following table outlines how the FireSIGHT System identifies detected application protocols in the Defense Center web interface: the network map, host profiles, event views, and so on.
 
     [bookmark: pgfId-1534676]
 
      
       
        
        [bookmark: pgfId-1534636]Table 45-3 [bookmark: 56953]FireSIGHT System Identification of Application Protocols 
 
        
        
         
         	 
           
           [bookmark: pgfId-1534640]Application 
          
  
         	 
           
           [bookmark: pgfId-1534642]Description 
          
  
        
 
         
         	[bookmark: pgfId-1534644]the application protocol name
  
         	[bookmark: pgfId-1534649]The Defense Center identifies an application protocol with its name if the application protocol was:
 
           
           	 [bookmark: pgfId-1534650]positively identified by the system
 
           	 [bookmark: pgfId-1534651]identified using NetFlow data and there is a port-application protocol correlation in  /etc/sf/services 
 
           	 [bookmark: pgfId-1534652]manually identified using the host input feature
 
           	 [bookmark: pgfId-1534653]identified by Nmap or another active source
 
          
  
        
 
         
         	[bookmark: pgfId-1534655]pending
  
         	[bookmark: pgfId-1534660]The Defense Center identifies an application protocol as pending if the system can neither positively nor negatively identify the application.
 [bookmark: pgfId-1534661]Most often, the system needs to collect and analyze more connection data (from which applications are identified) before it can identify a pending application. 
 [bookmark: pgfId-1534662]In the Application Details and Servers tables and in the host profile, the pending status appears only for application protocols where specific application protocol traffic was detected (rather than implied by detected client or web application traffic).
  
        
 
         
         	[bookmark: pgfId-1534664]unknown
  
         	[bookmark: pgfId-1534669]The Defense Center identifies an application protocol as unknown if the application:
 
           
           	 [bookmark: pgfId-1534670]does not match any of the system’s detectors
 
           	 [bookmark: pgfId-1534671]the application protocol was identified using NetFlow data, but there is no port-application protocol correlation in  /etc/sf/services 
 
          
  
        
 
         
         	[bookmark: pgfId-1534673]blank
  
         	[bookmark: pgfId-1534675]All available detected data has been examined and no application protocol was identified. In the Application Details and Servers tables and in the host profile, the application protocol is left blank for non-HTTP generic client traffic with no detected application protocol.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1534678][bookmark: 76936]Implied Application Protocol Detection from Client Detection
 
     [bookmark: pgfId-1534682]License: FireSIGHT
 
     [bookmark: pgfId-1534683]If the system can identify the client used in a connection between a monitored host accessing a non-monitored server, the Defense Center infers that the connection is using the application protocol that corresponds with the client. (Because the system tracks applications only on monitored networks, connection logs usually do not include application protocol information for connections where a monitored host is accessing a non-monitored server.) 
 
     [bookmark: pgfId-1534687]There are several consequences of the implied detection of an application protocol from the detection of a client:
 
      
      	 [bookmark: pgfId-1534688]Because the system does not generate a New TCP Port or New UDP Port event for these servers, the server does not appear in the Servers table. In addition, you cannot trigger either discovery event alerts or correlation rules using the detection of these application protocol as a criterion.
 
      	 [bookmark: pgfId-1534689]Because the application protocol is not associated with a host, you cannot view its details in host profiles, set its server identity, or use its information in host profile qualifications for traffic profiles or correlation rules. In addition, the system does not associate vulnerabilities with hosts based on this type of detection.
 
     
 
     [bookmark: pgfId-1534690]You can, however, trigger correlation events on the application protocol information in a connection. You can also use the application protocol information in connection logs to create connection trackers and traffic profiles.
 
    
 
     
      [bookmark: pgfId-1534692][bookmark: 36929]Host Limits and Discovery Event Logging
 
     [bookmark: pgfId-1534696]License: FireSIGHT
 
     [bookmark: pgfId-1534697]When the system detects a client, server, or web application, it generates a discovery event unless the associated host has already reached its maximum number of clients, servers, or web applications. 
 
     [bookmark: pgfId-1534698]Host profiles display up to 16 clients, 100 servers, and 100 web applications per host. See Working with Servers in the Host Profile and Viewing Applications in the Host Profile for more information. 
 
     [bookmark: pgfId-1534705]Note that actions dependent on the detection of clients, servers, or web applications are unaffected by this limit. For example, access control rules configured to trigger on a server will still log connection events.
 
    
 
     
      [bookmark: pgfId-1534707][bookmark: 45933]Special Considerations for Application Protocol Detection: Squid
 
     [bookmark: pgfId-1534711]License: FireSIGHT
 
     [bookmark: pgfId-1534712]The system positively identifies Squid server traffic when either:
 
      
      	 [bookmark: pgfId-1534713]the system detects a connection from a host on your monitored network to a Squid server where proxy authentication is enabled, or
 
      	 [bookmark: pgfId-1534714]the system detects a connection from a Squid proxy server on your monitored network to a target system (that is, the destination server where the client is requesting information or another resource)
 
     
 
     [bookmark: pgfId-1534715]However, the system cannot identify Squid service traffic if:
 
      
      	 [bookmark: pgfId-1534716]a host on your monitored network connects to a Squid server where proxy authentication is disabled, or
 
      	 [bookmark: pgfId-1534717]the Squid proxy server is configured to strip Via: header fields from its HTTP responses
 
     
 
    
 
     
      [bookmark: pgfId-1534720][bookmark: 94771]Special Considerations: SSL Application D[bookmark: marker-1534719]etection
 
     [bookmark: pgfId-1534724]License: FireSIGHT
 
     [bookmark: pgfId-1534729]The FireSIGHT System provides detectors that can use session information from a Secure Socket Layers (SSL) session to identify the application protocol, client application, or web application in the session. 
 
     [bookmark: pgfId-1534730]When the system detects an encrypted connection, it marks that connection as either a generic HTTPS connection or as a more specific secure protocol, such as SMTPS, when applicable. When the system detects an SSL session, it adds SSL client to the Client field in connection events for the session. If it identifies a web application for the session, the system generates discovery events for the traffic. 
 
     [bookmark: pgfId-1534731]For SSL application traffic, managed devices can also detect the common name from the server certificate and match that against a client or web application from an SSL host pattern. When the system identifies a specific client, it replaces SSL client with the name of the client.
 
     [bookmark: pgfId-1534735]Because the SSL application traffic is encrypted, the system can use only information in the certificate for identification, not application data within the encrypted stream. For this reason, SSL host patterns can sometimes only identify the company that authored the application, so SSL applications produced by the same company may have the same identification. 
 
     [bookmark: pgfId-1534736]In some instances, such as when an HTTPS session is launched from within an HTTP session, managed devices detect the server name from the client certificate in a client-side packet. 
 
     [bookmark: pgfId-1534737]To enable SSL application identification, you must create access control rules that monitor responder traffic. Those rules must have either an application condition for the SSL application or URL conditions using the URL from the SSL certificate. For network discovery, the responder IP address does not have to be in the networks to monitor in the network discovery policy; the access control policy configuration determines whether the traffic is identified. You can filter by the SSL protocol tag, in the application detectors list or when adding application conditions in access control rules, to identify detectors for SSL applications.
 
    
 
     
      [bookmark: pgfId-1534739][bookmark: 79691]Special Considerations: Referred Web Applications
 
     [bookmark: pgfId-1534741]Web servers sometimes [bookmark: marker-1534740]refer traffic to other websites, which are often advertisement servers. To help you better understand the context for referred traffic occurring on your network, the system lists the web application that referred the traffic in the Web Application field in events for the referred session. The VDB contains a list of known referred sites. When the system detects traffic from one of those sites, the referring site is stored with the event for that traffic. For example, if an advertisement accessed via Facebook is actually hosted on Advertising.com, the detected Advertising.com traffic is associated with the Facebook web application. The system can also detect referring URLs in HTTP traffic, such as when a website provides a simple link to another site; in this case, the referring URL appears in the HTTP Referrer event field.
 
     [bookmark: pgfId-1534742]In events, if a referring application exists, it is listed as the web application for the traffic, while the URL is that for the referred site. In the example above, the web application for the connection event for that traffic would be Facebook, but the URL would be Advertising.com. If no referring web application is detected, if the host refers to itself, or if there is a chain of referrals, a referred application may appear as the web application in the event. In the dashboard, connection and byte counts for web applications include sessions where the web application is associated with traffic referred by that application. 
 
     [bookmark: pgfId-1534743]Note that if you create a rule to act specifically on referred traffic, you should add a condition for the referred application, rather than the referring application. To block Advertising.com traffic referred from Facebook, for example, add an application condition to your access control rule for the Advertising.com application.
 
    
 
     
      [bookmark: pgfId-1534747][bookmark: 99760]Importing Third-Party Disc[bookmark: marker-1534745]overy [bookmark: marker-1534746]Data
 
     [bookmark: pgfId-1534751]License: FireSIGHT
 
     [bookmark: pgfId-1534752]You can use Nmap active scans to add information about operating systems, applications, and vulnerabilities, supplementing the data gathered by the system. For more information on Nmap scanning and scan results, see Understanding Nmap Scans.
 
     [bookmark: pgfId-1534756]You can also use the host input feature to supplement the information that the system gathers from monitoring network traffic, either by configuring a third-party application to interact with the FireSIGHT System via an API, or by manually adding data. You can create product, vulnerability, and fix mappings to map third-party data to Cisco definitions, enabling impact correlation for operating systems and servers. For more information on the host input feature and mapping third-party data, see the FireSIGHT System Host Input API Guide and Importing Host Input Data.
 
     [bookmark: pgfId-1534769]The system reconciles the collected data about operating system and server identities and determines each identity based on fingerprint source priority values, identity conflict resolution settings, and time of collection.
 
     [bookmark: pgfId-1534770]You can also configure your network map to use data from NetFlow-enabled devices to enhance your network map and event tables. For more information, see Understanding NetFlow.
 
    
 
     
      [bookmark: pgfId-1534775][bookmark: 15541]Uses for Discovery Data
 
     [bookmark: pgfId-1534779]License: FireSIGHT
 
     [bookmark: pgfId-1534780]Logging discovery data allows you to take advantage of many features in the FireSIGHT System, including:
 
      
      	 [bookmark: pgfId-1534784]viewing the network map, which is a detailed representation of your network assets and topology that you can view by grouping hosts and network devices, host attributes, application protocols, or vulnerabilities; see Using the Network Map
 
      	 [bookmark: pgfId-1534788]viewing host profiles, which are complete views of all the information available for your detected hosts; see Using Host Profiles
 
      	 [bookmark: pgfId-1534792]viewing dashboards, which (among other capabilities) can provide you with an at-a-glance view of your network assets and user activity; see Using Dashboards
 
      	 [bookmark: pgfId-1534796]viewing detailed information on the discovery events and user activity logged by the system; see Working with Discovery Events
 
      	 [bookmark: pgfId-1534802]creating reports based on discovery data; see Working with Reports
 
      	 [bookmark: pgfId-1534804]performing application and user control, that is, writing access control rules using application and user conditions; see Controlling Application Traffic and Adding a User Condition to an Access Control Rule
 
      	 [bookmark: pgfId-1534808]associating hosts and any servers or clients they are running with the exploits to which they are susceptible, which allows you to identify and mitigate vulnerabilities, evaluate the impact that intrusion events have on your network, and tune intrusion rule states so that they provide maximum protection for your network assets; see Working with Vulnerabilities in the Host Profile, Using Impact Levels to Evaluate Events, Understanding Indications of Compromise, and Tailoring Intrusion Protection to Your Network Assets
 
      	 [bookmark: pgfId-1534821]alerting you via email, SNMP trap, or syslog when the system generates either an intrusion event with a specific impact flag, or a specific type of discovery event; see Configuring External Alerting
 
      	 [bookmark: pgfId-1534825]monitor your organization’s compliance with a white list of allowed operating systems, clients, application protocols, and protocols; see Using the FireSIGHT System as a Compliance Tool
 
      	 [bookmark: pgfId-1534829]creating correlation policies with rules that trigger and generate correlation events when the system generates discovery events or detects user activity; see Configuring Correlation Policies and Rules
 
      	 [bookmark: pgfId-1534835]if you log NetFlow connections, using that connection data; see Logging Connections to the Defense Center or External Server
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1534840][bookmark: 73929]Understa[bookmark: marker-1534839]nding NetFlow
 
    [bookmark: pgfId-1576629]License: FireSIGHT
 
    [bookmark: pgfId-1576630]NetFlow is an embedded instrumentation within Cisco IOS Software that characterizes network operation. Standardized through the RFC process, NetFlow is available not only on Cisco networking devices, but can also be embedded in Juniper, FreeBSD, and OpenBSD devices.
 
    [bookmark: pgfId-1534846]NetFlow-enabled devices are widely used to capture and export data about the traffic that passes through those devices. NetFlow-enabled devices have a database called the NetFlow cache that stores records of the flows that pass through the devices. A flow, called a connection in the FireSIGHT System, is a sequence of packets that represents a session between a source and destination host, using specific ports, protocol, and application protocol.
 
    [bookmark: pgfId-1534853]For the networks you specify, FireSIGHT System managed devices detect the records exported by NetFlow-enabled devices, generate connection events based on the data in those records, and finally send those events to the Defense Center to be logged in the database. You can also configure the system to add host and application protocol information to the database, based on the information in NetFlow connections. 
 
    [bookmark: pgfId-1534857]You can use this discovery and connection data to supplement the data gathered directly by your managed devices. This is especially useful if you have NetFlow-enabled devices deployed on networks that your managed devices cannot monitor.
 
    [bookmark: pgfId-1534858]You configure NetFlow data collection, including connection logging, using rules in the network discovery policy. Contrast this with connection logging for connections detected by FireSIGHT System managed devices, which you configure per access control rule, as described in Logging Connections Based on Access Control Handling. Because NetFlow data collection is linked to networks rather than access control rules, you do not have as much granular control over which connections you want to log, Also, the system automatically saves all NetFlow-based connection events to the Defense Center connection event database; you cannot send them to the system log or an SNMP trap server.
 
    [bookmark: pgfId-1534868]For more information, see:
 
     
     	 [bookmark: pgfId-1534872]Differences Between NetFlow and FireSIGHT Data
 
     	 [bookmark: pgfId-1534876]Preparing to Analyze NetFlow Data
 
     	 [bookmark: pgfId-1598337]Uses for Discovery Data
 
     	 [bookmark: pgfId-1534884]Logging Connections to the Defense Center or External Server
 
    
 
     
      [bookmark: pgfId-1534890][bookmark: 14542]Differences Between NetFl[bookmark: marker-1534886]ow and FireSIGHT Data
 
     [bookmark: pgfId-1534894]License: FireSIGHT
 
     [bookmark: pgfId-1534895]With one exception (TCP flags), the information available in NetFlow records is more limited than the information generated by monitoring network traffic using managed devices. Because the system cannot directly analyze the traffic represented by NetFlow data, when the system processes NetFlow records it uses various methods to convert that data into connection logs as well as into host and application protocol records.
 
     [bookmark: pgfId-1534896]There are several differences between converted NetFlow data and the discovery and connection data gathered directly by your managed devices. You should keep the differences in mind when performing analysis that requires:
 
      
      	 [bookmark: pgfId-1534897]statistics on the number of detected connections
 
      	 [bookmark: pgfId-1534898]operating system and other host-related information (including vulnerabilities)
 
      	 [bookmark: pgfId-1534899]application data, including client information, web application information, and vendor and version server information
 
      	 [bookmark: pgfId-1534900]knowing which host in a connection is the initiator and which is the responder
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1534903]Tip For each field in a connection event, Table 39-1 indicates the available data depending on whether the connection was detected directly by FireSIGHT System managed devices, or if the connection event is based on NetFlow data.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1534909][bookmark: 65420]Number of Connection Events Generated Per Monitored Session
 
     [bookmark: pgfId-1534910]For connections detected directly by managed devices, depending on the access control rule action, you can log a bidirectional connection event at the beginning or end of a connection, or both.
 
     [bookmark: pgfId-1534911]However, because NetFlow-enabled devices export unidirectional connection data, the system always generates at least two connection events for each connection detected by NetFlow-enabled devices, depending on how you configured the devices. This also means that a summary’s connection count is incremented by two for every connection based on NetFlow data, providing an inflated count of the number of connections that are actually occurring on your network.
 
     [bookmark: pgfId-1534912]Note that if you configure your NetFlow-enabled devices to output records only when the connection ends, the system generates two connection events for that session. On the other hand, if you configure your NetFlow-enabled devices to output records at a fixed interval even if a connection is still ongoing, the system generates a connection event for each record exported by the device. For example, if you configure your NetFlow-enabled devices to output records for long-running connections every five minutes, and a particular connection lasts twelve minutes, the system generates six connection events for that session:
 
      
      	 [bookmark: pgfId-1534913]one pair of events for the first five minutes
 
      	 [bookmark: pgfId-1534914]one pair for the second five minutes
 
      	 [bookmark: pgfId-1534915]a final pair when the connection is terminated
 
     
 
     [bookmark: pgfId-1534919]For this reason. Cisco strongly recommends that you configure your NetFlow-enabled devices to output records only when monitored sessions close.
 
     [bookmark: pgfId-1534921][bookmark: 44715]Host and Operating System Data
 
     [bookmark: pgfId-1534922]Although you can configure the network discovery policy to add hosts to the network map based on NetFlow records, the host profile does not include any operating system or NetBIOS data for the hosts involved in the connection, nor can the system identify if the hosts are network devices (bridges, routers, NAT devices, or load balancers). You can, however, manually set a host’s operating system identity using the host input feature.
 
     [bookmark: pgfId-1534924][bookmark: 75027]Application Data
 
     [bookmark: pgfId-1534925]For connections detected directly by managed devices, the system can identify application protocols, clients, and web applications by examining the packets in the connection. 
 
     [bookmark: pgfId-1534926]When the system processes NetFlow records, the system uses a port correlation in /etc/sf/services to extrapolate application protocol identity. However, there is no vendor or version information for those application protocols, nor do connection logs contain information on client or web applications used in the session. You can, however, manually provide this information using the host input feature.
 
     [bookmark: pgfId-1534927]Note that a simple port correlation means that application protocols running on non-standard ports may be unidentified or misidentified. Additionally, if no correlation exists, the system marks the application protocol as unknown in connection logs.
 
     [bookmark: pgfId-1534929][bookmark: 53326]Vulnerability Mappings
 
     [bookmark: pgfId-1534933]The FireSIGHT System cannot determine which vulnerabilities might affect hosts added to the network map based on NetFlow records, unless you use the host input feature to manually set either a host’s operating system identity or an application protocol identity. Note that because there is no client information in NetFlow connections, you cannot associate client vulnerabilities with NetFlow hosts.
 
     [bookmark: pgfId-1534935][bookmark: 22081]Initiator and Responder Information in Connections
 
     [bookmark: pgfId-1534936]For connections detected directly by managed devices, the system can identify which host is the initiator, or source, and which is the responder, or destination. However, NetFlow data does not contain initiator or responder information. 
 
     [bookmark: pgfId-1534937]When the system processes NetFlow records, it uses an algorithm to determine this information based on the ports each host is using, and whether those ports are well-known:
 
      
      	 [bookmark: pgfId-1534938]If both or neither port being used is a well-known port, the system considers the host using the lower-number port to be the responder. 
 
      	 [bookmark: pgfId-1534939]If only one of the hosts is using a well-known port, the system considers that host to be the responder.
 
     
 
     [bookmark: pgfId-1534940]For this purpose, a well-known port is any port that is either numbered from 1 to 1023, or that contains application protocol information in /etc/sf/services on the managed device.
 
    
 
     
      [bookmark: pgfId-1534942][bookmark: 61546]Preparing to Analyze NetFlow Data
 
     [bookmark: pgfId-1534946]License: FireSIGHT
 
     [bookmark: pgfId-1534950]Before you configure the FireSIGHT System to analyze NetFlow data, you must enable the NetFlow feature on the routers or other NetFlow-enabled devices you plan to use, and configure the devices to export NetFlow version 5 data to a destination network where the sensing interface of a managed device is connected.
 
     [bookmark: pgfId-1534951]Note that the system can parse both NetFlow version 5 and NetFlow version 9 records. Your NetFlow-enabled devices must use one of those versions if you want to use them with your FireSIGHT System deployment. In addition, the system requires that specific fields be in the templates and records that your NetFlow-enabled devices broadcast. If your NetFlow-enabled devices are using version 9, which you can customize, you must make sure that the templates and records that the devices broadcast contain the following fields, in any order:
 
      
      	 [bookmark: pgfId-1534955]IN_BYTES (1)
 
      	 [bookmark: pgfId-1534956]IN_PKTS (2)
 
      	 [bookmark: pgfId-1534957]PROTOCOL (4)
 
      	 [bookmark: pgfId-1534958]TCP_FLAGS (6)
 
      	 [bookmark: pgfId-1534959]L4_SRC_PORT (7)
 
      	 [bookmark: pgfId-1534960]IPV4_SRC_ADDR (8)
 
      	 [bookmark: pgfId-1534961]L4_DST_PORT (11)
 
      	 [bookmark: pgfId-1534962]IPV4_DST_ADDR (12)
 
      	 [bookmark: pgfId-1534963]LAST_SWITCHED (21)
 
      	 [bookmark: pgfId-1534964]FIRST_SWITCHED (22)
 
      	 [bookmark: pgfId-1534965]IPV6_SRC_ADDR (27)
 
      	 [bookmark: pgfId-1534966]IPV6_DST_ADDR (28)
 
     
 
     [bookmark: pgfId-1534970]Because the FireSIGHT System uses managed devices to analyze NetFlow data, your deployment must include at least one managed device that can monitor your NetFlow-enabled devices. At least one sensing interface on that managed device must be connected to a network where it can collect the data that your NetFlow-enabled devices export. Because the sensing interfaces on managed devices do not usually have IP addresses, the system does not support the direct collection of NetFlow records.
 
     [bookmark: pgfId-1534975]In addition, Cisco strongly recommends that you configure your NetFlow-enabled devices to output records only when monitored sessions close. If you configure your NetFlow-enabled devices to output records at fixed intervals, analyzing the connection data derived from the NetFlow records may be more complicated; see Number of Connection Events Generated Per Monitored Session.
 
     [bookmark: pgfId-1534979]Finally, note that the Sampled NetFlow feature available on some NetFlow-enabled devices collects NetFlow statistics on only a subset of packets that pass through the devices. Although enabling this feature can improve CPU utilization on the NetFlow-enabled device, it may affect the data you are collecting for analysis by the system.
 
    
 
   
 
    
     [bookmark: pgfId-1534982][bookmark: 64284]Understanding Indication[bookmark: marker-1534981]s of Compromise
 
    [bookmark: pgfId-1534986]License: FireSIGHT
 
    [bookmark: pgfId-1553901]As a part of network discovery, the FireSIGHT System’s Data Correlator can correlate various types of data (intrusion events, Security Intelligence, connection events, and malware events) associated with hosts to determine whether a host on your monitored network is likely to be compromised by malicious means. These correlations are known as indications of compromise (IOC). You activate this feature by enabling it and any of many Cisco-predefined IOC rules in the discovery policy editor. When the feature is enabled, you can also edit rule states for individual hosts from that host’s host profile. Each IOC rule corresponds to one specific IOC tag, which is associated with a host.
 
    [bookmark: pgfId-1566684]In addition to the Data Correlator, Cisco’s endpoint-based Collective Security Intelligence Cloud data can also generate IOC tags from IOC rules. Because this data examines activity on a host itself — such as actions taken by or on individual programs — it can provide insights into possible threats that network-only data cannot. FireAMP IOC data from endpoints is transmitted via the Cisco cloud connection.
 ). Event views for events that can trigger IOC tags indicate whether an event triggered an IOC. 
    
 
     
      [bookmark: pgfId-1535013][bookmark: 79788]Understanding Indications of C[bookmark: marker-1535012]ompromise Types
 
     [bookmark: pgfId-1535017]License: FireSIGHT
 
     [bookmark: pgfId-1535018]There are many indications of compromise (IOC) rule and tag types. All are Cisco-predefined, and one IOC rule corresponds to one IOC tag. Because IOC rules trigger based on data provided by other features of the FireSIGHT System (and, for some events, the Cisco cloud), those features must be available and active for IOC rules to set IOC tags. When Cisco develops new endpoint-based malware event IOC types, the system automatically downloads them via the cloud and begins to use them. The lists below detail IOC rule types, the features with which they are associated, and any additional licensing requirements (beyond the FireSIGHT license required for network discovery):
 
      
      	 [bookmark: pgfId-1535034]Endpoint-Based Malware Event IOC Types
 
      	 [bookmark: pgfId-1535038]Intrusion Event IOC Types
 
      	 [bookmark: pgfId-1535042]Security Intelligence Event IOC Types
 
     
 
    
 
     
      [bookmark: pgfId-1535044][bookmark: 87787]Endpoint-Based Malware Event IOC Types
 
     [bookmark: pgfId-1535048]License: FireSIGHT
 
     [bookmark: pgfId-1535049]The following list contains examples of IOC types that are associated with endpoint-based malware events, which require a subscription to the Cisco cloud. In addition to the IOC types listed below, Cisco periodically develops new types, which your system downloads and implements automatically via your connection to the cloud.
 
     [bookmark: pgfId-1566909]For more information on configuring endpoint-based malware protection, see Working with Cloud Connections for FireAMP and Network-Based AMP vs Endpoint-Based FireAMP.
 
      
      	 [bookmark: pgfId-1535059]Adobe Reader Compromise — Adobe Reader launched shell
 
      	 [bookmark: pgfId-1535063]Adobe Reader Compromise — PDF Compromise Detected by FireAMP
 
      	 [bookmark: pgfId-1535067]CnC Connected — Suspected Botnet Detected by FireAMP
 
      	 [bookmark: pgfId-1535071]Dropper Infection — Dropper Infection Detected by FireAMP
 
      	 [bookmark: pgfId-1535075]Excel Compromise — Excel Compromise Detected by FireAMP
 
      	 [bookmark: pgfId-1535076]Excel Compromise — Excel launched shell
 
      	 [bookmark: pgfId-1566325]Generic IOC Detected by FireAMP
 
      	 [bookmark: pgfId-1535080]Java Compromise — Java Compromise Detected by FireAMP
 
      	 [bookmark: pgfId-1535081]Java Compromise — Java launched shell
 
      	 [bookmark: pgfId-1535085]Malware Detected — Threat Detected by FireAMP - Not Executed
 
      	 [bookmark: pgfId-1535086]Malware Detected — Threat Detected in File Transfer
 
      	 [bookmark: pgfId-1535090]Malware Executed — Threat Detected by FireAMP - Executed
 
      	 [bookmark: pgfId-1579225]Microsoft Calculator Compromise — Microsoft Calculator Compromise Detected by FireAMP
 
      	 [bookmark: pgfId-1579258]Microsoft Notepad Compromise — Microsoft Calculator Compromise Detected by FireAMP
 
      	 [bookmark: pgfId-1535094]PowerPoint Compromise — PowerPoint Compromise Detected by FireAMP
 
      	 [bookmark: pgfId-1535095]PowerPoint Compromise — PowerPoint launched shell
 
      	 [bookmark: pgfId-1535099]QuickTime Compromise — QuickTime Compromise Detected by FireAMP
 
      	 [bookmark: pgfId-1535100]QuickTime Compromise — QuickTime launched shell
 
      	 [bookmark: pgfId-1535104]Word Compromise — Word Compromise Detected by FireAMP
 
      	 [bookmark: pgfId-1535105]Word Compromise — Word launched shell
 
     
 
    
 
     
      [bookmark: pgfId-1535107][bookmark: 33577]Intrusion Event IOC Types
 
     [bookmark: pgfId-1535114]License: FireSIGHT+Protection
 
     [bookmark: pgfId-1535115]The following IOC types are associated with intrusion events, which require a Protection license. For more information on viewing intrusion events and configuring intrusion detection and protection, see Controlling Traffic Using Intrusion and File Policies and Viewing Intrusion Events.
 
      
      	 [bookmark: pgfId-1535125]CnC Connected — Intrusion Event - malware-backdoor
 
      	 [bookmark: pgfId-1535126]CnC Connected — Intrusion Event - malware-cnc
 
      	 [bookmark: pgfId-1535127]Exploit Kit — Intrusion Event - exploit-kit
 
      	 [bookmark: pgfId-1535128]Impact 1 Attack — Impact 1 Intrusion Event - attempted-admin
 
      	 [bookmark: pgfId-1535129]Impact 1 Attack — Impact 1 Intrusion Event - attempted-user
 
      	 [bookmark: pgfId-1535130]Impact 1 Attack — Impact 1 Intrusion Event - successful-admin
 
      	 [bookmark: pgfId-1535131]Impact 1 Attack — Impact 1 Intrusion Event - successful-user
 
      	 [bookmark: pgfId-1535132]Impact 1 Attack — Impact 1 Intrusion Event - web-application-attack
 
      	 [bookmark: pgfId-1535133]Impact 2 Attack — Impact 2 Intrusion Event - attempted-admin
 
      	 [bookmark: pgfId-1535134]Impact 2 Attack — Impact 2 Intrusion Event - attempted-user
 
      	 [bookmark: pgfId-1535135]Impact 2 Attack — Impact 2 Intrusion Event - successful-admin
 
      	 [bookmark: pgfId-1535136]Impact 2 Attack — Impact 2 Intrusion Event - successful-user
 
      	 [bookmark: pgfId-1535137]Impact 2 Attack — Impact 2 Intrusion Event - web-application-attack
 
     
 
    
 
     
      [bookmark: pgfId-1535139][bookmark: 25338]Security Intelligence Event IOC Types
 
     [bookmark: pgfId-1535146]License: FireSIGHT+Protection
 
     [bookmark: pgfId-1535150]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1535151]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1535152]The CnC Connected — Security Intelligence Event - CnC type is associated with Security Intelligence events, a type of connection event. The Security Intelligence feature requires a Protection license. For more information on configuring Security Intelligence and viewing Security Intelligence events, see Blacklisting Using Security Intelligence IP Address Reputation and Viewing Connection and Security Intelligence Data.
 
    
 
     
      [bookmark: pgfId-1535164]Viewing and Editing Indic[bookmark: marker-1535163]ations of Compromise Data
 
     [bookmark: pgfId-1535168]License: FireSIGHT
 
     [bookmark: pgfId-1535169]Outside the network discovery policy itself, you can view and edit indications of compromise (IOC) data in several other parts of the FireSIGHT System web interface:
 
      
      	 [bookmark: pgfId-1535173]In the dashboard, the Threats tab of the Summary Dashboard displays, by default, IOC tags by host and new IOC rules triggered over time. The Custom Analysis widget offers presets based on IOC data. For information, see Using Dashboards and Configuring the Custom Analysis Widget.
 
      	 [bookmark: pgfId-1535180]The Indications of Compromise section of the Context Explorer displays graphs of hosts by IOC category and IOC categories by host. For information, see Understanding the Indications of Compromise Section.
 
      	 [bookmark: pgfId-1535184]Event views for discovery (IOC), connection, Security Intelligence, intrusion, and malware events display (in the IOC column) whether an event triggered an IOC rule. Endpoint-based malware events that trigger IOC rules have the event type FireAMP IOC and appear with an event subtype that specifies the compromise. You can write compliance rules against all IOC data that appears in the event viewer. For more information, see the following sections:
 
       
       	 [bookmark: pgfId-1535191]Viewing Connection and Security Intelligence Data
 
       	 [bookmark: pgfId-1535195]Viewing Intrusion Events
 
       	 [bookmark: pgfId-1535199]Working with Malware Events
 
       	 [bookmark: pgfId-1535203]Working with Indications of Compromise
 
       	 [bookmark: pgfId-1535207]Configuring Correlation Policies and Rules
 
      
 
      	 [bookmark: pgfId-1535208]The Indications of Compromise tab of the network map lists hosts on your monitored network, grouped by IOC tag. For information, see Working with the Indications of Compromise Network Map.
 
      	 [bookmark: pgfId-1535212]In the host profile view for a potentially compromised host, you can view all IOC tags associated with that host, resolve any or all of its IOC tags, and configure IOC rule states. For information, see Working with Indications of Compromise in the Host Profile.
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1535219][bookmark: 14954]Creating a Network Discov[bookmark: marker-1535218]ery Policy
 
    [bookmark: pgfId-1535223]License: FireSIGHT
 
    [bookmark: pgfId-1535228]The network discovery policy on the Defense Center controls how the system collects data on your organization’s network assets and which network segments and ports are monitored.
 
    [bookmark: pgfId-1535231]Discovery rules within the policy specify what networks and ports the FireSIGHT System monitors to generate discovery data based on network data in traffic, and what zones the policy is applied to. Within a rule, you can configure whether hosts, applications, and users are discovered. You can create rules to exclude networks and zones from discovery. When you create a rule for discovery from a NetFlow device, you can choose to just log connections. 
 
    [bookmark: pgfId-1535233]The network discovery policy has a a single default rule in place, configured to discover applications in any IPv4 traffic on the 0.0.0.0/0 network. Note that you must have applied an access control policy to the targeted device before you can apply a network discovery policy. The rule does not exclude any networks, zones, or ports, host and user discovery is not configured, and a NetFlow device is not configured. Note that the policy is applied to any managed devices by default when they are registered to the Defense Center. To begin collecting host or data, you must add or modify discovery rules and reapply the policy to a device. 
 
    [bookmark: pgfId-1535239]Remember that the access control policy defines the traffic that you permit, and therefore the traffic you can monitor with network discovery. Note that this means if you block certain traffic using access control, the system cannot examine that traffic for host, user, or application activity. For example, if you block access to social networking applications in the access control policy, the system will not provide you with any discovery data on those applications. 
 
    [bookmark: pgfId-1535241]If you want to adjust the scope of network discovery, you can create additional discovery rules and modify or remove the default rule. You can configure discovery of data from NetFlow devices and can restrict the protocols for traffic where user data is discovered on your network. 
 
    [bookmark: pgfId-1535245]If you want to use the FireSIGHT System to perform intrusion detection and prevention but do not need to take advantage of discovery data, you can optimize performance by disabling new discovery. First, make sure that your applied access control policies do not contain rules with user, application, or URL conditions. Then, remove all rules from your network discovery policy and apply it to your managed devices. For more information on configuring access control rules, see Tuning Traffic Flow Using Access Control Rules.
 
    [bookmark: pgfId-1535249]If you enable user discovery in your discovery rules, you can detect users through user login activity in traffic over a set of application protocols. You can disable discovery in particular protocols across all rules if needed. Disabling some protocols can help avoid reaching the user limit associated with your FireSIGHT license, reserving available user count for users from the other protocols.
 
    [bookmark: pgfId-1535253]Advanced network discovery settings allow you to manage what data is logged, how discovery data is stored, what indications of compromise (IOC) rules are active, what vulnerability mappings are used for impact assessment, and what happens when sources offer conflicting discovery data. You can also add NetFlow devices and sources for host input. 
 
    [bookmark: pgfId-1535254]For more information, see:
 
     
     	 [bookmark: pgfId-1535258]Working with Discovery Rules
 
     	 [bookmark: pgfId-1535262]Restricting User Logging
 
     	 [bookmark: pgfId-1535266]Configuring Advanced Network Discovery Options
 
     	 [bookmark: pgfId-1535270]Applying the Network Discovery Policy
 
    
 
     
      [bookmark: pgfId-1535275][bookmark: 31086]Working with Dis[bookmark: marker-1535273]covery Rules
 
     [bookmark: pgfId-1535279]License: FireSIGHT
 
     [bookmark: pgfId-1535281]Discovery rules allow you to tailor the information discovered for your network map to include only the specific data you want. Rules in your network discovery policy are evaluated sequentially. Note that while you can create rules with overlapping monitoring criteria, doing so may affect your system performance.
 
     [bookmark: pgfId-1535282]When you exclude a host or a network from monitoring, the host or network does not appear in the network map and no events are reported for it. Cisco recommends that you exclude[bookmark: marker-1535286] load balancers (or specific ports on load balancers) and [bookmark: marker-1535287]NAT devices from monitoring. These devices may create excessive and misleading events, filling the database and overloading the Defense Center. For example, a monitored NAT device might exhibit multiple updates of its operating system in a short period of time. If you know the IP addresses of your load balancers and NAT devices, you can exclude them from monitoring.
 
      
       
     
 
     
 
     [bookmark: pgfId-1535291]Tip The system can identify many load balancers and NAT devices by examining your network traffic. To determine which hosts on your network are load balancers and NAT devices, apply your network discovery policy, wait for the system to populate the network map, then perform a search of hosts constraining on host type.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1535295]In addition, if you need to create a custom server fingerprint, you should temporarily exclude from monitoring the IP address that you are using to communicate with the host you are fingerprinting. Otherwise, the network map and discovery event views will be cluttered with inaccurate information about the host represented by that IP address. After you create the fingerprint, you can configure your policy to monitor that IP address again. For more information, see Fingerprinting Servers.
 
     [bookmark: pgfId-1535302]Cisco also recommends that you not monitor the same network segment with NetFlow-enabled devices and FireSIGHT System managed devices. Although ideally you should configure your network discovery policy with non-overlapping rules, the system does drop duplicate connection logs generated by managed devices. Note that you cannot drop duplicate connection logs for connections detected by both a managed device and a NetFlow-enabled device.
 
     [bookmark: pgfId-1535306]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1535310]Understanding Device Selection
 
      	 [bookmark: pgfId-1535314]Understanding Actions and Discovered Assets
 
      	 [bookmark: pgfId-1535318]Understanding Monitored Networks
 
      	 [bookmark: pgfId-1535322]Understanding Zones in Network Discovery Policies
 
      	 [bookmark: pgfId-1535326]Understanding Port Exclusions
 
      	 [bookmark: pgfId-1535330]Adding a Discovery Rule
 
      	 [bookmark: pgfId-1535334]Creating Network Objects
 
      	 [bookmark: pgfId-1535338]Creating Port Objects
 
     
 
    
 
     
      [bookmark: pgfId-1535340][bookmark: 47773]Understanding Device Selection
 
     [bookmark: pgfId-1535344]License: FireSIGHT
 
     [bookmark: pgfId-1535345]If you select a NetFlow device in a discovery rule, the rule is limited to discovery of NetFlow data for the specified networks. Select the NetFlow device before you configure other aspects of rule behavior, as the available rule actions change when you select a NetFlow device. In addition, you cannot configure port exclusions for NetFlow traffic. 
 
     [bookmark: pgfId-1535346]Before you can select a NetFlow device in a network discovery rule, you must configure a connection to the NetFlow device in the network discovery advanced settings. For more information, see Adding NetFlow-Enabled Devices.
 
    
 
     
      [bookmark: pgfId-1535351][bookmark: 70775]Understanding Actions and Discovered Assets
 
     [bookmark: pgfId-1535355]License: FireSIGHT
 
     [bookmark: pgfId-1535356]When you configure a discovery rule, you must select an action for the rule. The action determines what assets are discovered or excluded when the system processes the rule. However, note that the affect of a rule action depends on whether you are using the rule to discover data from a managed device or from a NetFlow-enabled device. 
 
     [bookmark: pgfId-1535357]Note that if you create a network discovery policy without any rules that discover hosts or users, applying the policy disables new discovery for the appliance. To optimize performance when using managed devices only for intrusion prevention, remove all discovery rules from your policy and apply it to the active devices.
 
     [bookmark: pgfId-1535358]The following table describes what assets are discovered by rules with the specified action settings in those two scenarios. 
 
     [bookmark: pgfId-1535405]
 
      
       
        
        [bookmark: pgfId-1535364]Table 45-4 Discovery Rule Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-1535370]Action 
          
  
         	 
           
           [bookmark: pgfId-1535372]Managed Device 
          
  
         	 
           
           [bookmark: pgfId-1535374]NetFlow 
          
  
        
 
         
         	[bookmark: pgfId-1535376]Exclude
  
         	 [bookmark: pgfId-1535378]Excludes the specified network from monitoring. If the source or destination host for a connection is excluded from discovery, the connection is recorded but discovery events are not created for excluded hosts.
  
        
 
         
         	[bookmark: pgfId-1535382]Discover: Hosts
  
         	[bookmark: pgfId-1535384]Adds hosts to the network map based on discovery events. (Optional, unless user discovery is enabled, then required.)
  
         	[bookmark: pgfId-1535386]Adds hosts to the network map based on NetFlow records. (Required)
  
        
 
         
         	[bookmark: pgfId-1535388]Discover: Applications
  
         	[bookmark: pgfId-1535390]Adds applications to the network map based on application detectors. Note that you cannot discover hosts or users in a rule without also discovering applications. (Required)
  
         	[bookmark: pgfId-1535392]Adds application protocols to the network map based on NetFlow records and the port-application protocol correlation in 
/etc/sf/services. (Optional)
  
        
 
         
         	[bookmark: pgfId-1535394]Discover: Users
  
         	[bookmark: pgfId-1535396]Adds users to the users table and logs user activity based on activity detected in traffic matching the user protocols configured in the network discovery policy. (Optional)
  
         	[bookmark: pgfId-1535398]n/a
  
        
 
         
         	[bookmark: pgfId-1535400]Log NetFlow Connections
  
         	[bookmark: pgfId-1535402]n/a
  
         	[bookmark: pgfId-1535404]Logs NetFlow connections only. Does not discover hosts or applications.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1535408][bookmark: 86236]Understanding Mon[bookmark: marker-1535407]itored Networks
 
     [bookmark: pgfId-1535412]License: FireSIGHT
 
     [bookmark: pgfId-1535413]A discovery rule causes discovery of monitored assets only in traffic to and from hosts in the specified networks. For a discovery rule, discovery occurs for connections that have at least one IP address within the networks specified, with events generated only for IP addresses within the networks to monitor. The default discovery rule discovers applications only on the 0.0.0.0/0 and ::/0 networks. 
 
     [bookmark: pgfId-1535414]For rules with a specified NetFlow device and the Log Network Connections option enabled, connections to and from IP addresses in the specified networks are also logged. Note that network discovery rules provide the only way to log NetFlow network connections.
 
     [bookmark: pgfId-1535415]You can also use network object or object groups to specify the networks to monitor. If you modify a network object used in the network discovery policy, you must reapply the policy for those changes to take effect for discovery.
 
    
 
     
      [bookmark: pgfId-1535419][bookmark: 23237]Understanding Zones in Netwo[bookmark: marker-1535418]rk Discovery Policies
 
     [bookmark: pgfId-1535423]License: FireSIGHT
 
     [bookmark: pgfId-1535424]For performance reasons, you should configure each discovery rule so that the zones in the rule include the sensing interfaces on your managed devices that are physically connected to the networks-to-monitor in the rule. 
 
     [bookmark: pgfId-1535425]Unfortunately, you may not always be kept informed of network configuration changes. A network administrator may modify a network configuration through routing or host changes without informing you, which may make it challenging to stay on top of proper network discovery policy configurations. If you do not know how the sensing interfaces on your managed devices are physically connected to your network, leave the zone configuration as the default, which is to apply the discovery rule to all zones in your deployment. (If no zones are excluded, the discovery policy is applied to all zones.)
 
    
 
     
      [bookmark: pgfId-1535429][bookmark: 80789]Understanding Port Exc[bookmark: marker-1535428]lusions
 
     [bookmark: pgfId-1535433]License: FireSIGHT
 
     [bookmark: pgfId-1535436]Just as you can exclude hosts from monitoring (see Understanding Actions and Discovered Assets), you can exclude specific [bookmark: marker-1535438]ports from monitoring. 
 
     [bookmark: pgfId-1535439]For example, load balancers can report multiple applications on the same port in a short period of time. You can configure your network discovery policy so that it excludes that port from monitoring, such as excluding port 80 on a load balancer that handles a web farm.
 
     [bookmark: pgfId-1535440]As another scenario, your organization may use a custom client that uses a specific range of ports. If the traffic from this client generates excessive and misleading events, you can exclude those ports from monitoring. Similarly, you may decide that you do not want to monitor DNS traffic. In that case, you could configure your policy so that it does not monitor port 53.
 
     [bookmark: pgfId-1535441]When adding ports to exclude, you can decide whether to use a reusable port object from the Available Ports list, add ports directly to the source or destination exclusion lists, or create a new reusable port and then move it into the exclusion lists. 
 
     [bookmark: pgfId-1535442]Note that you cannot configure NetFlow-enabled devices to exclude ports from monitoring.
 
    
 
     
      [bookmark: pgfId-1535444][bookmark: 88172]Adding a Discovery Rule
 
     [bookmark: pgfId-1535448]License: FireSIGHT
 
     [bookmark: pgfId-1535449]You can configure discovery rules to tailor the discovery of host and application data to your needs. Note that when you modify an object referenced in a rule, you must reapply the network discovery policy for those changes to take effect. 
 
     [bookmark: pgfId-1535450]To add a discovery rule:
 
     [bookmark: pgfId-1535451]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1535452]Step 1 Check your access control policies to ensure that you are logging connections as needed for the traffic where you want to discover network data. 
 
     [bookmark: pgfId-1569460]For more information, see Logging Connections Based on Access Control Handling. To discover the most data, log at the end of the connection for traffic you want to discover.
 
     [bookmark: pgfId-1535459]Step 2 Select Policies > Network Discovery.
 
     [bookmark: pgfId-1535460]The Network Discovery Policy page appears.
 
     [bookmark: pgfId-1535461]Step 3 Click Add Rule.
 
     [bookmark: pgfId-1535462]The Add Rule pop-up window appears.
 
     [bookmark: pgfId-1535463]Step 4 You have two options:
 
      
       
       	 [bookmark: pgfId-1535464]If you plan to use the rule to monitor NetFlow traffic, within the Add Rule pop-up window, click  NetFlow Device . 
 
      
 
     
 
     [bookmark: pgfId-1535465]The NetFlow Device page appears.
 
     [bookmark: pgfId-1535466]Note that the NetFlow page is available only if you have added a NetFlow device to the discovery policy. For more information, see Adding NetFlow-Enabled Devices.
 
      
       
       	 [bookmark: pgfId-1535473]If you plan to use the rule to monitor managed devices, skip to step  6 .
 
      
 
     
 
     [bookmark: pgfId-1535476]For more information, see Differences Between NetFlow and FireSIGHT Data and Understanding Device Selection
 
     [bookmark: pgfId-1535481]Step 5 Select the IP address for the NetFlow device you want to use from the drop-down list. 
 
     [bookmark: pgfId-1535483]Step 6 [bookmark: 68399]Set the action for the rule:
 
      
       
       	 [bookmark: pgfId-1535484]To exclude all traffic that matches the rule from network discovery, select  Exclude . Note that the Port Exclusions tab is disabled when you select this rule action.
 
       	 [bookmark: pgfId-1535485]To discover the selected types of data in traffic that matches the rule, select  Discovery and select or clear the appropriate data type check boxes. 
 
      
 
     
 
     [bookmark: pgfId-1535486]If monitoring managed device traffic, application logging is required. If monitoring users, host logging is required. If monitoring NetFlow traffic, note that you cannot log users and that logging applications is optional. 
 
      
       
       	 [bookmark: pgfId-1535487]If monitoring NetFlow traffic, to use the rule to log connections in NetFlow traffic, select  Log NetFlow Connections . Note that this option only appears after you have selected a NetFlow device in the rule.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1535488]Note The system detects connections in NetFlow traffic based on network discovery policy settings. Connection logging in managed device traffic is configured in the access control policy. For more information, see Logging Connections in Network Traffic.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1535492]For more information on rule actions and discovery of assets, see Understanding Actions and Discovered Assets
 
     [bookmark: pgfId-1535496]Step 7 Every discovery rule must include at least one network. Optionally, to restrict the rule action to specific networks, click the Networks tab, select a network from the Available Networks list, and click Add, or type the network below the Networks list and click Add. 
 
     [bookmark: pgfId-1535499]For information on network monitoring, see Understanding Monitored Networks. For information on adding network objects to the Available Networks list, see Creating Network Objects. Note that If you modify a network object used in the network discovery policy, you must reapply the policy for those changes to take effect for discovery.
 
     [bookmark: pgfId-1535504]Step 8 Optionally, to restrict the rule actions to traffic in specific zones, click Zones, select a zone or zones from the Available Zones list, and click Add.
 
     [bookmark: pgfId-1535507]For information on selecting zones for monitoring, see Understanding Zones in Network Discovery Policies.
 
     [bookmark: pgfId-1535509]Step 9 To exclude ports from monitoring, click Port Exclusions.
 
     [bookmark: pgfId-1535510]The Port Exclusions page appears.
 
     [bookmark: pgfId-1535511]Step 10 To exclude specific source ports from monitoring, you have two options:
 
      
       
       	 [bookmark: pgfId-1535512]Select a port or ports from the  Available Ports list and click  Add to Source . 
 
       	 [bookmark: pgfId-1535513]To exclude traffic from a specific source port without adding a port object, under the  Selected Source Ports list, select the appropriate protocol from the  Protocol drop-down list, type a port number from 1 to 65535 into the  Port field, and click  Add . 
 
      
 
     
 
     [bookmark: pgfId-1535516]For information on excluding ports from monitoring, see Understanding Port Exclusions. For information on adding port objects to the Available Ports list, see Creating Port Objects. Note that if you modify a port object used in the network discovery policy, you must reapply the policy for those changes to take effect for discovery.
 
     [bookmark: pgfId-1535521]Step 11 To exclude specific destination ports from monitoring, you have two options:
 
      
       
       	 [bookmark: pgfId-1535522]Select a port or ports from the  Available Ports list and click  Add to Destination .
 
       	 [bookmark: pgfId-1535523]To exclude traffic from a specific destination port without adding a port object, under the  Selected Destination Ports list, select the appropriate protocol from the  Protocol drop-down list, type a port number from 1 to 65535 into the  Port field, and click  Add . 
 
      
 
     
 
     [bookmark: pgfId-1535524]Step 12 If you are finished editing the rule, click Save to return to the discovery policy rule list.
 
     [bookmark: pgfId-1535525]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
     [bookmark: pgfId-1548122]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1535530][bookmark: 94757]Creating Network Objects
 
     [bookmark: pgfId-1535534]License: FireSIGHT
 
     [bookmark: pgfId-1535535]The list of available networks that appears in a discovery rule contains reusable network object and groups that can be used anywhere in the FireSIGHT System. You can add new network objects to the list. Note that when you modify an object referenced in a rule, you must reapply the network discovery policy for those changes to take effect.
 
     [bookmark: pgfId-1535539]To create a new network object:
 
     [bookmark: pgfId-1535540]Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1535541]Step 1 Select Policies > Network Discovery.
 
     [bookmark: pgfId-1535542]The Network Discovery Policy page appears.
 
     [bookmark: pgfId-1535543]Step 2 Click Add Rule.
 
     [bookmark: pgfId-1535544]The Add Rule pop-up window appears.
 ). 
     
 
     [bookmark: pgfId-1535549]The Network Objects pop-up window appears.
 
     [bookmark: pgfId-1535550]Step 4 Type a Name for the network object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
     [bookmark: pgfId-1535551]Step 5 For each IP address, CIDR block, and prefix length you want to add to the network object, type its value and click Add.
 
     [bookmark: pgfId-1535552]Step 6 Click Save to add the network object to the Available Networks list. 
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1548163]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535558][bookmark: 61728]Creating Port Objects
 
    [bookmark: pgfId-1535562]License: FireSIGHT
 
    [bookmark: pgfId-1535563]The list of available ports that appears in a discovery rule contains reusable port objects and groups that can be used anywhere in the FireSIGHT System. You can add new port objects to the list. Note that when you modify an object referenced in a rule, you must reapply the network discovery policy for those changes to take effect.
 
    [bookmark: pgfId-1535567]To create a new port object:
 
    [bookmark: pgfId-1535568]Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1535569]Step 1 Click Port Exclusions.
 
    [bookmark: pgfId-1535570]The Port Exclusions page appears.
 ). 
    
 
    [bookmark: pgfId-1535575]The Port Objects pop-up window appears.
 
    [bookmark: pgfId-1535576]Step 3 Supply a Name for the port object. You can use any printable standard ASCII characters except a pipe (|) or curly braces ({}).
 
    [bookmark: pgfId-1535577]Step 4 In the Protocol field, specify the protocol of the traffic you want to exclude.
 
    [bookmark: pgfId-1535578]Select TCP, UDP, or Other and choose an option from the drop-down list to select a protocol or All.
 
    [bookmark: pgfId-1535579]Step 5 In the Port(s) field, enter the ports you want to exclude from monitoring.
 
    [bookmark: pgfId-1535580]You can specify a single port, a range of ports using the dash (-), or a comma-separated list of ports and port ranges. Allowed port values are from 1 to 65535.
 
    [bookmark: pgfId-1535581]Step 6 Click Save to add the port to the Available Ports list. 
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1548179]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1535590][bookmark: 55171]Restri[bookmark: marker-1535587]cting Use[bookmark: marker-1535588]r Logging
 
    [bookmark: pgfId-1535594]License: FireSIGHT
 
    [bookmark: pgfId-1535596]When you apply a network discovery policy with rules that discover users, users are discovered in traffic that uses the AIM, IMAP, LDAP, Oracle, POP3, SMTP, FTP, HTTP, MDNS, and SIP protocols. These users are added to the users table, accessible through the Analysis menu. You can restrict the protocols where user activity is discovered to reduce the total number of detected users so you can focus on users likely to provide the most complete user information.
 
    [bookmark: pgfId-1535600]The total number of detected users the Defense Center can store depends on your FireSIGHT license. After you reach the licensed limit, in most cases the system stops adding new users to the database. To add new users, you must either manually delete old or inactive users from the database, or purge all users from the database. Restricting protocol detection helps minimize user name clutter and preserve FireSIGHT user licenses. 
 
    [bookmark: pgfId-1535607]For example, obtaining user names through protocols such as AIM, POP3, and IMAP may introduce user names not relevant to your organization due to network access from contractors, visitors, and other guests.
 
    [bookmark: pgfId-1535608]As another example, AIM, Oracle, and SIP logins may create extraneous user records. This occurs because these login types are not associated with any of the user metadata that the system obtains from an LDAP server, nor are they associated with any of the information contained in the other types of login that your managed devices detect. Therefore, the Defense Center cannot correlate these users with other types of users.
 
    [bookmark: pgfId-1535612]Keep in mind that only managed devices can detect non-LDAP user logins. If you are using only User Agents installed on Microsoft Active Directory servers to detect user activity, restricting non-LDAP logins has no effect. Also, you cannot restrict SMTP logging. This is because users are not added to the database based on SMTP logins; although the system detects SMTP logins, the logins are not recorded unless there is already a user with a matching email address in the database.
 
    [bookmark: pgfId-1535616]You can choose to record failed login attempts for failed user logins detected in LDAP, POP3, FTP, or IMAP traffic. A failed login attempt does not add a new user to the list of users in the database. Note that the User Agent does not report failed login activity. The user activity type for detected failed login activity is Failed User Login.
 
    [bookmark: pgfId-1592427]Note that the system cannot distinguish between failed and successful HTTP logins. To see HTTP user information, you must enable Capture Failed Login Attempts.
 
    [bookmark: pgfId-1535621]To restrict the protocols where user logins are detected:
 
    [bookmark: pgfId-1535622]Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1535623]Step 1 Select Policies > Network Discovery.
 
    [bookmark: pgfId-1535624]The Network Discovery Policy page appears.
 
    [bookmark: pgfId-1535625]Step 2 Click User. 
 
    [bookmark: pgfId-1535626]The User page appears.
 
    [bookmark: pgfId-1535627]Step 3 Select check boxes for protocols where you want to detect logins or clear check boxes for protocols where you do not want to detect logins.
 
    [bookmark: pgfId-1591118]Step 4 Optionally, to record failed login attempts detected in LDAP, POP3, FTP, or IMAP traffic, or to capture user information for HTTP logins, enable Capture Failed Login Attempts.
 
    [bookmark: pgfId-1535628]Step 5 Click Save to save the network policy.
 
    [bookmark: pgfId-1535629]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
    [bookmark: pgfId-1548191]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535636][bookmark: 94276]Configuring Advanced Network Disco[bookmark: marker-1535634]very Options
 
    [bookmark: pgfId-1535640]License: FireSIGHT
 
    [bookmark: pgfId-1535642]The Advanced tab of the network discovery policy allows you to configure policy-wide settings for what events are detected, how long discovery data is retained and how often it is updated, what vulnerability mappings are used for impact correlation, and how operating system and server identity conflicts are resolved. In addition, you can add host input sources and NetFlow-enabled devices to allow import of data from other sources.
 
    [bookmark: pgfId-1535643]Note that the database event limits for discovery and user activity events are set in the system policy. For more information, see Configuring Database Event Limits.
 
    [bookmark: pgfId-1535647]To configure advanced settings:
 
    [bookmark: pgfId-1535648]Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1535649]Step 1 Select Policies > Network Discovery.
 
    [bookmark: pgfId-1535650]The Network Discovery Policy page appears.
 
    [bookmark: pgfId-1535651]Step 2 Click Advanced. 
 
    [bookmark: pgfId-1535652]The Advanced page appears.
 
    [bookmark: pgfId-1535653]Step 3 Edit advanced settings as needed:
 
     
      
      	 [bookmark: pgfId-1535657]Configuring General Settings
 
      	 [bookmark: pgfId-1535661]Configuring Identity Conflict Resolution
 
      	 [bookmark: pgfId-1535665]Enabling Vulnerability Impact Assessment Mappings
 
      	 [bookmark: pgfId-1535669]Setting Indications of Compromise Rules
 
      	 [bookmark: pgfId-1535673]Adding NetFlow-Enabled Devices
 
      	 [bookmark: pgfId-1535677]Configuring Data Storage
 
      	 [bookmark: pgfId-1535681]Configuring Discovery Event Logging
 
      	 [bookmark: pgfId-1535685]Adding Identity Sources
 
     
 
    
 
    [bookmark: pgfId-1535686]Step 4 When you finish configuring settings, click Save to save the policy. 
 
    [bookmark: pgfId-1535687]Step 5 When the policy is complete and saved, apply the policy to put the updated settings into effect. For more information, see Applying the Network Discovery Policy.
 
    [bookmark: pgfId-1548206]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535694][bookmark: 31375]Configuring General S[bookmark: marker-1535692][bookmark: marker-1535693]ettings
 
    [bookmark: pgfId-1535698]License: FireSIGHT
 
    [bookmark: pgfId-1535699]The general settings control how often the system updates information in the network map and whether server banners are captured during discovery.
 
    [bookmark: pgfId-1535700]Capture Banners
 
    [bookmark: pgfId-1535701]Select this check box if you want the system to store header information from network traffic that advertises server vendors and versions (“banners”). This information can provide additional context to the information gathered. You can access server banners collected for hosts by accessing server details.
 
    [bookmark: pgfId-1535702]Update Interval
 
    [bookmark: pgfId-1535703]The interval at which the system updates information (such as when any of a host’s IP addresses was last seen, when an application was used, or the number of hits for an application). The default setting is 3600 seconds (1 hour).
 
    [bookmark: pgfId-1535704]Note that setting a lower interval for update timeouts provides more accurate information in the host display, but generates more network events.
 
    [bookmark: pgfId-1535705]To update general settings:
 
    [bookmark: pgfId-1535706]Admin/Discovery Admin
 
    
 . 
    
 
    [bookmark: pgfId-1535711]The General Settings pop-up window appears.
 
    [bookmark: pgfId-1535712]Step 2 Update the settings as needed.
 
    [bookmark: pgfId-1535713]Step 3 Click Save to save the general settings and return to the Advanced tab of the network discovery policy. 
 
    [bookmark: pgfId-1535714]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
    [bookmark: pgfId-1553635]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535720][bookmark: 61450]Configuring Identity C[bookmark: marker-1535719]onflict Resolution
 
    [bookmark: pgfId-1535724]License: FireSIGHT
 
    [bookmark: pgfId-1535725]The system matches fingerprints for operating systems and servers against patterns in traffic to determine what operating system and which applications are running on a particular host. To provide the most reliable operating system and server identity information, the system collates fingerprint information from several sources. 
 
    [bookmark: pgfId-1535726]The system uses all passive data to derive operating system identities and assign a confidence value. For more information on current identities and how the system selects the current identity, see Enhancing Your Network Map. 
 
    [bookmark: pgfId-1535730]By default, unless there is an identity conflict, identity data added by a scanner or third-party application overrides identity data detected by the FireSIGHT System. You can use the Identity Sources settings to rank scanner and third-party application fingerprint sources by priority. The system retains one identity for each source, but only data from the highest priority third-party application or scanner source is used as the current identity. Note, however, that user input data overrides scanner and third-party application data regardless of priority. 
 
    [bookmark: pgfId-1535734]An identity conflict occurs when the system detects an identity that conflicts with an existing identity that came from either the active scanner or third-party application sources listed in the Identity Sources settings or from a FireSIGHT System user. By default, identity conflicts are not automatically resolved and you must resolve them through the host profile or by rescanning the host or re-adding new identity data to override the passive identity. However, you can set your system to always automatically resolve the conflict by keeping the passive identity or to always resolve it by keeping the active identity. 
 
    [bookmark: pgfId-1535738]Generate Identity Conflict Event
 
    [bookmark: pgfId-1535739]Enable this option to generate an event when an identity conflict occurs on a host in the network map. 
 
    [bookmark: pgfId-1535740]Automatically Resolve Conflicts
 
    [bookmark: pgfId-1535741]You have the following options:
 
     
      
      	 [bookmark: pgfId-1535742]To force manual conflict resolution of identity conflicts, select  Disabled from the  Automatically Resolve Conflicts drop-down list.
 
      	 [bookmark: pgfId-1535743]To use the passive fingerprint when an identity conflict occurs, select  Identity  from the  Automatically Resolve Conflicts drop-down list.
 
      	 [bookmark: pgfId-1535744]To use the current identity from the highest priority active source when an identity conflict occurs, select  Keep Active from the  Automatically Resolve Conflicts drop-down list.
 
     
 
    
 
    [bookmark: pgfId-1535745]To update identity conflict resolution settings:
 
    [bookmark: pgfId-1535746]Admin/Discovery Admin
 
    
 . 
    
 
    [bookmark: pgfId-1535751]The Edit Identity Conflict Settings pop-up window appears.
 
    [bookmark: pgfId-1535752]Step 2 Update the settings as needed.
 
    [bookmark: pgfId-1535753]Step 3 Click Save to save the identity conflict settings and return to the Advanced tab of the network discovery policy. 
 
    [bookmark: pgfId-1535754]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
    [bookmark: pgfId-1553662]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535760][bookmark: 26180]Enabling Vulnerability Impact Asse[bookmark: marker-1535759]ssment Mappings
 
    [bookmark: pgfId-1535764]License: FireSIGHT
 
    [bookmark: pgfId-1535768]You can configure how the FireSIGHT System performs impact correlation with intrusion events. Your options are as follows:
 
     
     	 [bookmark: pgfId-1535773]Select  Use Network Discovery Vulnerability Mappings if you want to use system-based vulnerability information to perform impact correlation.
 
     	 [bookmark: pgfId-1535774]Select  Use Third-Party Vulnerability Mappings if you want to use third-party vulnerability references to perform impact correlation. For more information, see Mapping Third-Party Vulnerabilities or the  FireSIGHT System Host Input API Guide .
 
    
 
    [bookmark: pgfId-1535781]You can select either or both of the check boxes. If the system generates an intrusion event and the host involved in the event has servers or an operating system with vulnerabilities in the selected vulnerability mapping sets, the intrusion event is marked with the Vulnerable (level 1: red) impact icon. For any servers which do not have vendor or version information, note that you need to configure vulnerability mapping in the system policy. For more information, see Mapping Vulnerabilities for Servers.
 
    [bookmark: pgfId-1535785]If you clear both check boxes, intrusion events will never be marked with the Vulnerable (level 1: red) impact icon. For more information, see Using Impact Levels to Evaluate Events.
 
    [bookmark: pgfId-1535789]To update vulnerability settings:
 
    [bookmark: pgfId-1535790]Admin/Discovery Admin
 
    
 . 
    
 
    [bookmark: pgfId-1535795]The Edit Vulnerability Settings pop-up window appears.
 
    [bookmark: pgfId-1535796]Step 2 Update the settings as needed.
 
    [bookmark: pgfId-1535797]Step 3 Click Save to save the vulnerability settings and return to the Advanced tab of the network discovery policy. 
 
    [bookmark: pgfId-1535798]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
    [bookmark: pgfId-1553686]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535804][bookmark: 95699]Setting Indicatio[bookmark: marker-1535803]ns of Compromise Rules
 
    [bookmark: pgfId-1535808]License: FireSIGHT
 
    [bookmark: pgfId-1535809]For your system to detect and tag indications of compromise (IOC), you must first activate at least one IOC rule in your discovery policy. Each IOC rule corresponds to one type of IOC tag, and all IOC rules are predefined by Cisco; you cannot create original rules. You can enable any or all rules, depending on the needs of your network and organization. For example, if hosts using software such as Microsoft Excel never appear on your monitored network, you may decide not to enable the IOC tags that pertain to Excel-based threats. For more information on the IOC feature, see Understanding Indications of Compromise.
 
    [bookmark: pgfId-1535819]You must also enable the FireSIGHT System features associated with the IOC rules you enable, such as intrusion and malware protection; if a rule’s associated feature is not enabled, no relevant data is collected and the rule cannot trigger. For more information on the types of IOC rules and their associated features, see Understanding Indications of Compromise Types.
 
    [bookmark: pgfId-1535823]To set indications of compromise rules in the discovery policy:
 
    [bookmark: pgfId-1535824]Admin/Discovery Admin
 
    
 . 
    
 
    [bookmark: pgfId-1535829]The Edit Indications of Compromise Settings pop-up window appears.
 
    [bookmark: pgfId-1535830]Step 2 To toggle the entire IOC feature off or on, click the slider next to Enable IOC.
 
    [bookmark: pgfId-1535831]Step 3 To enable or disable individual IOC rules, click the slider in the rule’s Enabled column.
 
    [bookmark: pgfId-1535832]Step 4 Click Save to save your IOC rule settings and return to the Advanced tab of the discovery policy.
 
    [bookmark: pgfId-1535833]Your changes are saved.
 
    [bookmark: pgfId-1535834]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
    [bookmark: pgfId-1553698]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535840][bookmark: 39034]Adding NetFlow-Enable[bookmark: marker-1535839]d Devices
 
    [bookmark: pgfId-1535844]License: FireSIGHT
 
    [bookmark: pgfId-1535845]If you have enabled the NetFlow feature on your NetFlow-enabled devices, you can use the connection data exported by these devices to supplement the connection data collected by Cisco devices.
 
    [bookmark: pgfId-1535849]Before you can use them in discovery rules, you must configure the NetFlow-enabled devices you plan to use (see Preparing to Analyze NetFlow Data), then add them to the network discovery policy.
 
    [bookmark: pgfId-1535856]For more information on using NetFlow data with the FireSIGHT System, including information on additional prerequisites, see Understanding NetFlow.
 
    [bookmark: pgfId-1535860]To add NetFlow-enabled devices for connection data collection:
 
    [bookmark: pgfId-1535861]Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1535862]Step 1 Select Policies > Network Discovery. 
 
    [bookmark: pgfId-1535863]The Network Discovery Policy page appears.
 
    [bookmark: pgfId-1535864]Step 2 Click Advanced.
 
    [bookmark: pgfId-1535865]The Advanced page appears.
 ) next to NetFlow Devices. 
    
 
    [bookmark: pgfId-1535871]The Add NetFlow Device pop-up window appears.
 
    [bookmark: pgfId-1535873]Step 4 [bookmark: 13292]In the IP Address field, enter the IP address of the NetFlow-enabled device you want to use to collect connection data.
 
    [bookmark: pgfId-1535880]Step 5 To add additional NetFlow-enabled devices, repeat steps 3 and 4.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1535888]Step 6 Click Save.
 
   [bookmark: pgfId-1535889]The device appears on the list of NetFlow-enabled devices.
 
   [bookmark: pgfId-1535890]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
   [bookmark: pgfId-1553722]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1535896][bookmark: 45806]Configuring Data St[bookmark: marker-1535895]orage
 
    [bookmark: pgfId-1535900]License: FireSIGHT
 
    [bookmark: pgfId-1535901]Data storage settings control the kinds of data stored in the database, and therefore determine the data that the FireSIGHT System can use. These settings also control how long data is retained in the network map.
 
    [bookmark: pgfId-1535905]The following options comprise the network discovery data storage settings.
 
    [bookmark: pgfId-1535906]When Host Limit Reached
 
    [bookmark: pgfId-1535910]You can control how hosts are handled when the Defense Center reaches its host limit (as determined by the FireSIGHT license) and the network map is full. This option is especially valuable if you want to prevent spoofed hosts from taking the place of valid hosts in the network map. To drop old hosts, select Drop hosts from the When Host Limit Reached drop-down list.To drop new hosts, select Don’t insert new hosts from the When Host Limit Reached drop-down list. For more information, see Understanding FireSIGHT Host and User License Limits.
 
    [bookmark: pgfId-1535917]Host Timeout
 
    [bookmark: pgfId-1535918]The amount of time that passes, in minutes, before the system drops a host from the network map due to inactivity. The default setting is 10080 minutes (7 days). Individual host IP and MAC addresses can time out individually, but a host does not disappear from the network map unless all of its associated addresses have timed out.
 
    [bookmark: pgfId-1535919]To avoid premature timeout of hosts, make sure that the host timeout value is longer than the update interval in the network discovery policy. For more information on the update interval, see Configuring General Settings. 
 
    [bookmark: pgfId-1535923]Server Timeout
 
    [bookmark: pgfId-1535924]The amount of time that passes, in minutes, before the system drops a server from the network map due to inactivity. The default setting is 10080 minutes (7 days).
 
    [bookmark: pgfId-1535925]To avoid premature timeout of servers, make sure that the service timeout value is longer than the update interval in the network discovery policy. For more information, see Configuring General Settings.
 
    [bookmark: pgfId-1535929]Client Application Timeout
 
    [bookmark: pgfId-1535930]The amount of time that passes, in minutes, before the system drops a client from the network map due to inactivity. The default setting is 10080 minutes (7 days).
 
    [bookmark: pgfId-1535931]You should make sure that the client timeout value is longer than the update interval in the network discovery policy. For more information, see Configuring General Settings. 
 
    [bookmark: pgfId-1535935]To update data storage settings:
 
    [bookmark: pgfId-1535936]Admin/Discovery Admin
 
    
 . 
    
 
    [bookmark: pgfId-1535941]The Data Storage Settings pop-up window appears.
 
    [bookmark: pgfId-1535942]Step 2 Update the settings as needed.
 
    [bookmark: pgfId-1535943]Step 3 Click Save to save the data storage settings and return to the Advanced tab of the network discovery policy. 
 
    [bookmark: pgfId-1535944]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
    [bookmark: pgfId-1553741]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535950][bookmark: 41521]Configuring Discovery Event Loggi[bookmark: marker-1535949]ng
 
    [bookmark: pgfId-1535954]License: FireSIGHT
 
    [bookmark: pgfId-1535955]The Event Logging Settings control whether discovery and host input events are logged. If you do not log an event, you cannot retrieve it in event views or use it to trigger correlation rules. 
 
    [bookmark: pgfId-1535956]To set event logging settings:
 
    [bookmark: pgfId-1535957]Admin/Discovery Admin
 
    
 . 
    
 
    [bookmark: pgfId-1535962]The Event Logging Settings pop-up window appears.
 
    [bookmark: pgfId-1535963]Step 2 Select or clear the check boxes next to the discovery and host input event types you want to log in the database. See Understanding Discovery Event Types and Understanding Host Input Event Types for information about each event type.
 
    [bookmark: pgfId-1535970]Step 3 Click Save to save the event logging settings and return to the Advanced tab of the network discovery policy. 
 
    [bookmark: pgfId-1535971]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
    [bookmark: pgfId-1553773]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1535977][bookmark: 57864]Adding Identity Sou[bookmark: marker-1535976]rces
 
    [bookmark: pgfId-1535981]License: FireSIGHT
 
    [bookmark: pgfId-1535982]You can add new active sources through this page, or change the priority or timeout settings for existing sources. Note that adding a scanner to this page does not add the full integration capabilities that exist for the Nmap scanners, but does allow integration of imported third-party application or scan results. If you import data from a third-party application or scanner, remember to make sure that you map vulnerabilities from the source to the vulnerabilities in the network map. For more information, see Mapping Third-Party Vulnerabilities.
 
    [bookmark: pgfId-1535986]To add identity sources:
 
    [bookmark: pgfId-1535987]Admin/Discovery Admin
 
    
 . 
    
 
    [bookmark: pgfId-1535992]The Edit OS and Server Identity Sources pop-up window appears. 
 
    [bookmark: pgfId-1535993]Step 2 To add a new source, click Add Source. 
 
    [bookmark: pgfId-1535994]The Add Identity Source pop-up window appears.
 
    [bookmark: pgfId-1535995]Step 3 Type a Name for the source. 
 
    [bookmark: pgfId-1535996]Step 4 Select the input source type from the Type drop-down list:
 
     
      
      	 [bookmark: pgfId-1535997]Select  Scanner  if you plan to import scan results using the AddScanResult function.
 
      	 [bookmark: pgfId-1535998]Select  Application if you do not plan to import scan results.
 
     
 
    
 
    [bookmark: pgfId-1535999]Step 5 To indicate the duration of time that should elapse between the addition of an identity to the network map by this source and the deletion of that identity, select Hours, Days, or Weeks from the Timeout drop-down list and type the appropriate duration.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1536004]Step 6 Optionally, to promote a source and cause the operating system and application identities to be used in favor of sources below it in the list, select the source and click the up arrow. 
 
   [bookmark: pgfId-1536005]Step 7 Optionally, to demote a source and cause the operating system and application identities to be used only if there are no identities provided by sources above it in the list, select the source and click the down arrow. 
 
   [bookmark: pgfId-1536006]Step 8 Click Save to save the identity source settings and return to the Advanced tab of the network discovery policy. 
 
   [bookmark: pgfId-1536007]You must apply the network discovery policy for your changes to take effect. For more information, see Applying the Network Discovery Policy.
 
   [bookmark: pgfId-1553794]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1536013][bookmark: 96904]Applying the Network Disco[bookmark: marker-1536012]very Policy
 
    [bookmark: pgfId-1536017]License: FireSIGHT
 
    [bookmark: pgfId-1536018]By default, the network discovery policy is applied to any targeted zones on managed devices when they are registered with the Defense Center. Applying the network discovery policy allows the system to begin monitoring your network according to your specifications. If you change the network discovery policy, you must reapply it before your changes take effect.
 
    [bookmark: pgfId-1536022]When you reapply the network discovery policy:
 
     
     	 [bookmark: pgfId-1536023]the system deletes and then rediscovers MAC address, TTL, and hops information from the network map for the hosts in your monitored networks 
 
     	 [bookmark: pgfId-1536024]the affected managed devices discard any discovery data that has not yet been sent to the Defense Center
 
    
 
    [bookmark: pgfId-1536028]When you apply a network discovery policy, make sure that you have already applied an access control policy to all devices managed by the Defense Center. If an access control policy has not been applied to each device, the network discovery policy apply fails. Note that you cannot apply a network discovery policy on a Defense Center where no FireSIGHT license is installed.
 
    [bookmark: pgfId-1536035]If you modify a network or port object used in the network discovery policy, you must reapply the policy for those changes to take effect for discovery.
 
    [bookmark: pgfId-1536036]Note that you cannot apply a network discovery policy to stacked devices running different versions of the FireSIGHT System (for example, if an upgrade on one of the devices fails).
 
    [bookmark: pgfId-1536040]To apply the network discovery policy:
 
    [bookmark: pgfId-1536041]Admin/Security Approver
 
    
 
    [bookmark: pgfId-1536042]Step 1 Select Policies > Network Discovery. 
 
    [bookmark: pgfId-1536043]The Network Discovery Policy page appears.
 
    [bookmark: pgfId-1536044]Step 2 Click Apply.
 
    [bookmark: pgfId-1536045]A message appears, confirming that you want to apply the policy to all zones targeted by access control policies on the Defense Center.
 
    [bookmark: pgfId-1536049]Step 3 Click Yes to apply the policy.
 
    [bookmark: pgfId-1553812]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1164863]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1424538]Enhancing Network [bookmark: marker-2129795]Discovery 
      
      
 
     
 
 
    [bookmark: pgfId-1829118]The information about your network traffic collected by the FireSIGHT System is most valuable to you when the system can correlate this information to identify the hosts on your network that are most vulnerable and most important.
 
    [bookmark: pgfId-1285580]As an example, if you have several devices on your network running a customized version of SuSE Linux, the system cannot identify that operating system and so cannot map vulnerabilities to the hosts. However, knowing that the system has a list of vulnerabilities for SuSE Linux, you may want to create a custom fingerprint for one of the hosts that can then be used to identify the other hosts running the same operating system. You can include a mapping of the vulnerability list for SuSE Linux in the fingerprint to associate that list with each host that matches the fingerprint. 
 
    [bookmark: pgfId-1930831]The system also allows you to input host data from third-party systems directly into the network map, using the host input feature. However, third-party operating system or application data does not automatically map to vulnerability information. If you want to see vulnerabilities and perform impact correlation for hosts using third-party operating system, server, and application protocol data, you must map the vendor and version information from the third-party system to the vendor and version listed in the vulnerability database (VDB). You also may want to maintain the host input data on an ongoing basis. Note that even if you map application data to FireSIGHT System vendor and version definitions, imported third-party vulnerabilities are not used for impact assessment for clients or web applications.
 
    [bookmark: pgfId-1838598]If the system cannot identify application protocols running on hosts on your network, you can create user-defined application protocol detectors that allow the system to identify the applications based on a port or a pattern. You can also import, activate, and deactivate certain application detectors to further customize the application detection capability of the FireSIGHT System.
 
    [bookmark: pgfId-1812100]You can also replace detection of operating system and application data using scan results from the Nmap active scanner or augment the vulnerability lists with third-party vulnerabilities. The system may reconcile data from multiple sources to determine the identity for an application. For more information on how the system does this, see Understanding Current Identities. For more information on active scanning, see Configuring Active Scanning.
 
    [bookmark: pgfId-1493740]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1493745]Assessing Your Detection Strategy
 
     	 [bookmark: pgfId-1602484]Enhancing Your Network Map
 
     	 [bookmark: pgfId-1493749]Using Custom Fingerprinting
 
     	 [bookmark: pgfId-1730483]Working with Application Detectors
 
     	 [bookmark: pgfId-1493804]Importing Host Input Data
 
    
 
   
 
    
     [bookmark: pgfId-1429736][bookmark: 55927]Assessing Your Detection[bookmark: marker-1443166] Strategy
 
    [bookmark: pgfId-1817779]License: FireSIGHT
 
    [bookmark: pgfId-1470857]Before you make any changes to the system’s default detection capabilities, you should analyze what hosts are not being identified correctly and why, so you can decide what solution to implement. Use the following as a guide for your decision:
 
     
     	 [bookmark: pgfId-1437089]Are Your Managed Devices Correctly Placed?
 
     	 [bookmark: pgfId-1437801]Do Unidentified Operating Systems Have a Unique TCP Stack?
 
     	 [bookmark: pgfId-1437830]Can the FireSIGHT System Identify All Applications?
 
     	 [bookmark: pgfId-1437835]Have You Applied Patches that Fix Vulnerabilities?
 
     	 [bookmark: pgfId-1437840]Do You Want to Track Third-Party Vulnerabilities?
 
    
 
     
      [bookmark: pgfId-1437090][bookmark: 29985]Are Your Managed Devices Correctly Placed?
 
     [bookmark: pgfId-1898131]License: FireSIGHT
 
     [bookmark: pgfId-1899779]If network devices such as load balancers, proxy servers, or NAT devices reside between the managed device and the unidentified or misidentified host, place a managed device closer to the misidentified host rather than using custom fingerprinting. Cisco does not recommend using custom fingerprinting in this scenario.
 
    
 
     
      [bookmark: pgfId-1437107][bookmark: 50008]Do Unidentified Operating Systems [bookmark: marker-1443563]Have a Unique TCP Stack?
 
     [bookmark: pgfId-1898155]License: FireSIGHT
 
     [bookmark: pgfId-1083211]If the system misidentifies a host, you should investigate why the host is misidentified to help you decide between creating and activating a custom fingerprint or substituting Nmap or host input data for discovery data. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1433083] 
      Caution If you encounter misidentified hosts, contact your support representative before creating custom fingerprints. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1433143]If a host is running an operating system that is not detected by the system by default and does not share identifying TCP stack characteristics with existing detected operating systems, you should create a custom fingerprint.
 
     [bookmark: pgfId-1432364]For example, if you have a customized version of Linux with a unique TCP stack that the system cannot identify, you would benefit from creating a custom fingerprint, which allows the system to identify the host and continuing monitoring it, rather than using scan results or third-party data, which require you to actively update the data yourself on an ongoing basis.
 
     [bookmark: pgfId-1433323]Note that many open source Linux distributions use the same kernel, and as such, the system identifies them using the Linux kernel name. If you create a custom fingerprint for a Red Hat Linux system, you may see other operating systems (such as Debian Linux, Mandrake Linux, Knoppix, and so on) identified as Red Hat Linux, because the same fingerprint matches multiple Linux distributions.
 
     [bookmark: pgfId-1437135]You should not use a fingerprint in every situation. For example, a modification may have been made to a host’s TCP stack so that it resembles or is identical to another operating system. For example, an Apple Mac OS X host is altered, making its fingerprint identical to a Linux 2.4 host, causing the system to identify it as Linux 2.4 instead of Mac OS X. If you create a custom fingerprint for the Mac OS X host, it may cause all legitimate Linux 2.4 hosts to be erroneously identified as Mac OS X hosts. In this case, if Nmap correctly identifies the host, you could schedule regular Nmap scans for that host.
 
     [bookmark: pgfId-1433277]If you import data from a third-party system using host input, you must map the vendor, product, and version strings that the third party uses to describe servers and application protocols to the Cisco definitions for those products. For more information, see Managing Third-Party Product Mappings. Note that even if you map application data to FireSIGHT System vendor and version definitions, imported third-party vulnerabilities are not used for impact assessment for clients or web applications.
 
     [bookmark: pgfId-1605222]The system may reconcile data from multiple sources to determine the current identity for an operating system or application. For more information on how the system does this, see Understanding Current Identities. 
 
     [bookmark: pgfId-1433205]For Nmap data, you can schedule regular Nmap scans. For host input data, you can regularly run the Perl script for the import or the command line utility. However, note that active scan data and host input data may not be updated with the frequency of discovery data. 
 
    
 
     
      [bookmark: pgfId-1437144][bookmark: 15780]Can the FireSIGHT System Identify All [bookmark: marker-1443564]Applications?
 
     [bookmark: pgfId-1898179]License: FireSIGHT
 
     [bookmark: pgfId-1730505]If a host is correctly identified by the system but has unidentified applications, you can create a user-defined detector to provide the system with port and pattern matching information to help identify the application. For more information, see Creating a User-Defined Application Protocol Detector.
 
    
 
     
      [bookmark: pgfId-1437642][bookmark: 80924]Have You Applied Patches [bookmark: marker-1443565]that Fix Vulnerabilities?
 
     [bookmark: pgfId-1898195]License: FireSIGHT
 
     [bookmark: pgfId-1431341]If the system correctly identifies a host but does not reflect applied fixes, you can use the host input feature to import patch information. When you import patch information, you must map the fix name to a fix in the database. For more information, see Mapping Third-Party Product Fixes.
 
    
 
     
      [bookmark: pgfId-1437764][bookmark: 32022]Do You Want to Track Third-[bookmark: marker-1443566]Party Vulnerabilities?
 
     [bookmark: pgfId-1898211]License: FireSIGHT
 
     [bookmark: pgfId-1934178]If you have vulnerability information from a third-party system that you want to use for impact correlation, you can map the third-party vulnerability identifiers for servers and application protocols to vulnerability identifiers in the Cisco database and then import the vulnerabilities using the host input feature. For more information on using the host input feature, see the FireSIGHT System Host Input API Guide. For more information on mapping third-party vulnerabilities, see Mapping Third-Party Vulnerabilities. Note that even if you map application data to FireSIGHT System vendor and version definitions, imported third-party vulnerabilities are not used for impact assessment for clients or web applications.
 
    
 
   
 
    
     [bookmark: pgfId-1934192][bookmark: 40980]Enhancing Your Network Map
 
    [bookmark: pgfId-1898227]License: FireSIGHT
 
    [bookmark: pgfId-1601561]The FireSIGHT System builds the network map using data it detects by passively analyzing traffic. It also uses data added through active sources such as the host input feature and the Nmap scanner. Understanding how the system decides which data to use for an application or operating system identity can help you decide how best to augment the system’s passive detection capabilities with active input sources.
 
    [bookmark: pgfId-1603530]For more information, see the following topics:
 
     
     	 [bookmark: pgfId-1603579]Understanding Passive Detection
 
     	 [bookmark: pgfId-1603606]Understanding Active Detection
 
     	 [bookmark: pgfId-1609593]Understanding Current Identities
 
     	 [bookmark: pgfId-1609176]Understanding Identity Conflicts
 
    
 
     
      [bookmark: pgfId-1609213][bookmark: 49617]Understanding Pas[bookmark: marker-1677855]sive Detection
 
     [bookmark: pgfId-1898243]License: FireSIGHT
 
     [bookmark: pgfId-1867018]Passive detection is the detection of host operating system, client, and application information through analysis of traffic passively collected by the system. The system uses information in the VDB to help it identify your network assets. 
 
     [bookmark: pgfId-1866921]If the system cannot identify an operating system on a host, you can manually determine it and then create a custom server or client fingerprint to help the system recognize that operating system on other hosts with similar operating system characteristics. 
 
     [bookmark: pgfId-1609236]The system uses all collected passive fingerprints for a host operating system to create a derived fingerprint. The system cre[bookmark: marker-1677893][bookmark: marker-1677898]ates derived fingerprints by applying a formula which calculates the most likely identity using the confidence value of each collected fingerprint and the amount of corroborating fingerprint data between identities. Common elements are identified between identities.
 
     [bookmark: pgfId-1866943]If you use user-defined application detectors on your network, you can augment the system’s application detection capabilities by creating custom detectors that provide the system with the information it needs to identify those applications. NetFlow can also add passively detected application information to the network map. 
 
     [bookmark: pgfId-1609243]Note that the system does not use application protocol and operating system data that it classified as unknown because it is unable to interpret the data. The managed device reports the identity to the Defense Center as unknown and the identity data is not used to derive fingerprints.
 
    
 
     
      [bookmark: pgfId-1609245][bookmark: 66631]Understanding Active Dete[bookmark: marker-1677860]ction
 
     [bookmark: pgfId-1898259]License: FireSIGHT
 
     [bookmark: pgfId-1609254]Active detection is addition, to the network map, of data collected by active sources, such as host operating system and application information. For example, you can use the Nmap scanner to actively scan the hosts that you target on your network. Nmap discovers operating systems and applications on hosts. 
 
     [bookmark: pgfId-1609255]In addition, the host input feature allows you to actively add host input data to the network map. There are two different categories of host input data: 
 
      
      	 [bookmark: pgfId-1644669]You can modify a host’s operating system or application identity through the FireSIGHT System user interface. Data added through the interface is  user input data . 
 
      	 [bookmark: pgfId-1644676]You can also import data using a command line utility. Imported data is  host import input data . 
 
     
 
     [bookmark: pgfId-1609262]The system retains one identity for each active source. When you run an Nmap scan instance, for example, the results of the previous scan are replaced with the new scan results. However, if you run an Nmap scan and then replace those results with data from a client whose results are imported through the command line, the system retains both the identities from the Nmap results and the identities from the import client. Then the system uses the priorities set in the system policy to determine which active identity to use as the current identity. 
 
     [bookmark: pgfId-1609269]Note that user input is considered one source, even if it comes from different users. As an example, if UserA sets the operating system through the host profile, and then UserB changes that definition through the host profile, the definition set by UserB is retained, and the definition set by UserA is discarded. In addition, note that user input overrides all other active sources and is used as the current identity if it exists.
 
    
 
     
      [bookmark: pgfId-1609178][bookmark: 73743]Understanding Current Identities
 
     [bookmark: pgfId-1898275]License: FireSIGHT
 
     [bookmark: pgfId-1603078]The current identity for an application or an operat[bookmark: marker-1677903]ing system on a host is the identity that the system finds most likely to be correct. 
 
     [bookmark: pgfId-1649921]The system uses the current identity for an operating system or application for the following purposes: 
 
      
      	 [bookmark: pgfId-1649922]to assign vulnerabilities to a host
 
      	 [bookmark: pgfId-1649923]for impact assessment
 
      	 [bookmark: pgfId-1649924]when evaluating correlation rules written against operating system identifications, host profile qualifications, and compliance white lists
 
      	 [bookmark: pgfId-1649925]for display in the Hosts and Servers table views in workflows 
 
      	 [bookmark: pgfId-1649926]for display in the host profile 
 
      	 [bookmark: pgfId-1649927]to calculate the operating system and application statistics on the Discovery Statistics page 
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1907039]For example, if a user sets the operating system to Windows 2003 Server on a host, Windows 2003 Server is the current identity. Attacks which target Windows 2003 Server vulnerabilities on that host are given a higher impact, and the vulnerabilities listed for that host in the host profile include Windows 2003 Server vulnerabilities. 
 
     [bookmark: pgfId-1608305]The database may retain information from several sources for the operating system or for a particular application on a host. 
 
     [bookmark: pgfId-1608309]The system treats an operating system or application identity as the current identity when the source for the data has the highest source priority. Possible sources have the following priority order: 
 
     [bookmark: pgfId-1644726]1. user 
 
     [bookmark: pgfId-1644737]2. scanner and application (set in the network discovery policy) 
 
     [bookmark: pgfId-1644748]3. managed devices
 
     [bookmark: pgfId-1649868]4. NetFlow
 
     [bookmark: pgfId-1649869]Note that a new higher priority application identity will not override a current application identity if it has less detail than the current identity. 
 
     [bookmark: pgfId-1649870]In addition, note that when an identity conflict occurs, the resolution of the conflict depends on settings in the network discovery policy or on your manual resolution, as described in Understanding Identity Conflicts. 
 
    
 
     
      [bookmark: pgfId-1601644][bookmark: 15439][bookmark: 88339]Understanding Identity Con[bookmark: marker-1677908]flicts
 
     [bookmark: pgfId-1898312]License: FireSIGHT
 
     [bookmark: pgfId-1646567]An identity conflict occurs when the system reports a new passive identity that conflicts with the current active identity and previously reported passive identities. For example, the previous passive identity for an operating system is reported as Windows 2000, then an active identity of Windows XP becomes current. Next, the system detects a new passive identity of Ubuntu Linux 8.04.1. The Windows XP and the Ubuntu Linux identities are in conflict. 
 
     [bookmark: pgfId-1646552]When an identity conflict exists for the identity of the host’s operating system or one of the applications on the host, the system lists both conflicting identities as current and uses both for impact assessment until the conflict is resolved. 
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1914845]A user with Administrator privileges can also configure the system to generate an event when an identity conflict occurs. That user can then set up a correlation policy with a correlation rule that uses an Nmap scan as a correlation response. When an event occurs, Nmap scans the host to obtain updated host operating system and application data. 
 
    
 
   
 
    
     [bookmark: pgfId-1599642][bookmark: 53129]Using Custom Finge[bookmark: marker-1599641]rprinting
 
    [bookmark: pgfId-1898344]License: FireSIGHT
 
    [bookmark: pgfId-1430916]The FireSIGHT System includes operating system fingerprints that the system uses to identify the operating system on each host it detects. However, sometimes the system cannot identify a host operating system or misidentifies it because no fingerprints exist that match the operating system. To correct this problem, you can create a custom fingerprint, which provides a pattern of operating system characteristics unique to the unknown or misidentified operating system, to supply the name of the operating system for identification purposes.
 
    [bookmark: pgfId-1429861]If the system cannot match a host’s operating system, it cannot identify the vulnerabilities for the host, because the system derives the list of vulnerabilities for each host from its operating system fingerprint. For example, if the system detects a host running Microsoft Windows, the system has a stored Microsoft Windows vulnerability list that it adds to the host profile for that host based on the detected Windows operating system. 
 
    [bookmark: pgfId-1429871]As an example, if you have several devices on your network running a new beta version of Microsoft Windows, the system cannot identify that operating system and so cannot map vulnerabilities to the hosts. However, knowing that the system has a list of vulnerabilities for Microsoft Windows, you may want to create a custom fingerprint for one of the hosts that can then be used to identify the other hosts running the same operating system. You can include a mapping of the vulnerability list for Microsoft Windows in the fingerprint to associate that list with each host that matches the fingerprint.
 
    [bookmark: pgfId-1429878]When you create a custom fingerprint, you can add a customized display of operating system information, and you can select the operating system vendor, product name, and product version for the operating system which the system should use as a model for the vulnerability list for the fingerprint. The Defense Center lists the set of vulnerabilities associated with that fingerprint for any hosts running the same operating system. If the custom fingerprint you create does not have any vulnerabilities mappings in it, the system uses the fingerprint to assign the custom operating system information you provide in the fingerprint. When the system sees new traffic from a host that has already been detected and currently resides in the network map, the system updates the host with the new fingerprint information. the system also uses the new fingerprint to identify any new hosts with that operating system the first time they are detected.
 
    [bookmark: pgfId-1429904]Before attempting to fingerprint a host, you should determine why the host is not being identified correctly to decide whether custom fingerprinting is a viable solution. For more information, see Assessing Your Detection Strategy.
 
    [bookmark: pgfId-1432305]You can create two types of fingerprints with the system:
 
     
     	 [bookmark: pgfId-1429937]Client fingerprints, which identify operating systems based on the SYN packet that the host sends when it connects to a TCP application running on another host on the network.
 
    
 
    [bookmark: pgfId-1429941]See Fingerprinting Clients for information about how to obtain a client fingerprint for a host.
 
     
     	 [bookmark: pgfId-1429942]Server fingerprints, which identify operating systems based on the SYN-ACK packet that the host uses to respond to an incoming connection to a running TCP application.
 
    
 
    [bookmark: pgfId-1429946]See Fingerprinting Servers for information about how to obtain a server fingerprint for a host.
 
    [bookmark: pgfId-1429950]After creating fingerprints, you must activate them before the system can associate them with hosts. See Managing Fingerprints for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-1429954]Note If both a client and server fingerprint match the same host, the client fingerprint is used.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1429957][bookmark: 74068]Fingerprinting [bookmark: marker-1429956]Clients
 
     [bookmark: pgfId-1898368]License: FireSIGHT
 
     [bookmark: pgfId-1429965]Client fingerprints identify operating systems based on the SYN packet a host sends when it connects to a TCP application running on another host on the network.
 
     [bookmark: pgfId-1596233]If the Defense Center does not have direct contact with monitored hosts, you can specify a device that is managed by the Defense Center and is closest to the host you intend to fingerprint when specifying client fingerprint properties.
 
     [bookmark: pgfId-1429983]Before you begin the fingerprinting process, obtain the following information about the host you want to fingerprint:
 
      
      	 [bookmark: pgfId-1429987]The number of network hops between the host and the Defense Center or the device you use to obtain the fingerprint. (Cisco strongly recommends that you directly connect the Defense Center or the device to the same subnet that the host is connected to.)
 
      	 [bookmark: pgfId-1430006]The network interface (on the Defense Center or the device) that is connected to the network where the host resides.
 
      	 [bookmark: pgfId-1430007]The actual operating system vendor, product, and version of the host.
 
      	 [bookmark: pgfId-1430008]Access to the host in order to generate client traffic.
 
     
 
     [bookmark: pgfId-1430016]To obtain a client fingerprint for a host:
 
     [bookmark: pgfId-1472462]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1430017]Step 1 Select Policies > Network Discovery, then click Custom Operating Systems.
 
     [bookmark: pgfId-1430018]The Custom Fingerprint page appears.
 
     [bookmark: pgfId-1430019]Step 2 Click Create Custom Fingerprint.
 
     [bookmark: pgfId-1430020]The Create Custom Fingerprint page appears.
 
     [bookmark: pgfId-1430032]Step 3 [bookmark: 27409]From the Device drop-down list, select the Defense Center or the device that you want to use to collect the fingerprint.
 
     [bookmark: pgfId-1430038]Step 4 [bookmark: 72823]In the Fingerprint Name field, type an identifying name for the fingerprint.
 
     [bookmark: pgfId-1430043]Step 5 In the Fingerprint Description field, type a description for the fingerprint.
 
     [bookmark: pgfId-1430044]Step 6 From the Fingerprint Type list, select Client.
 
     [bookmark: pgfId-1430045]Step 7 In the Target IP Address field, type an IP address of the host you want to fingerprint. Note that the fingerprint will only be based on traffic to and from the host IP address you specify, not any of the host’s other IP addresses (if it has any).
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2053701] 
      Caution For information on enabling IPv6 on managed devices and Defense Centers, see 
      Configuring Management Interfaces. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1430051]Step 8 In the Target Distance field, enter the number of network hops between the host and the device that you selected in step 3 to collect the fingerprint.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1430055] 
      Caution This must be the actual number of physical network hops to the host, which may or may not be the same as the number of hops detected by the system. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1430059]Step 9 From the Interface list, select the network interface that is connected to the network segment where the host resides.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1596298] 
      Caution Cisco recommends that you do 
      not use the sensing interface on a managed device for fingerprinting for several reasons. First, fingerprinting does not work if the sensing interface is on a span port. Also, if you use the sensing interface on a device, the device stops monitoring the network for the amount of time it takes to collect the fingerprint. You can, however, use the management interface or any other available network interfaces to perform fingerprint collection. If you do not know which interface is the sensing interface on your device, refer to the 
      Installation Guide for the specific model you are using to fingerprint. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1430067]Step 10 If you want to display custom information in the host profile for fingerprinted hosts (or if the host you want to fingerprint does not reside in the OS Vulnerability Mappings section), select Use Custom OS Display in the Custom OS Display section and provide the values you want to display in host profiles for the following:
 
      
       
       	 [bookmark: pgfId-1430068]In the  Vendor String field, type the operating system’s vendor name. For example, the vendor for Microsoft Windows would be Microsoft.
 
       	 [bookmark: pgfId-1430069]In the  Product String field, type the operating system’s product name. For example, the product name for Microsoft Windows 2000 would be Windows.
 
       	 [bookmark: pgfId-1430070]In the  Version String field, type the operating system’s version number. For example, the version number for Microsoft Windows 2000 would be 2000.
 
      
 
     
 
     [bookmark: pgfId-2025008]Step 11 In [bookmark: marker-2025007]the OS Vulnerability Mappings section, select the operating system, product, and versions you want to use for vulnerability mapping.
 
     [bookmark: pgfId-1978845]For example, if you want your custom fingerprint to assign the list of vulnerabilities from Redhat Linux 9 to matching hosts, select Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the major version.
 
      
       
     
 
     
 
     [bookmark: pgfId-1977812]Tip When creating a fingerprint, you assign a single vulnerability mapping for the fingerprint. After the fingerprint is created and activated, you can add additional vulnerability mappings for other versions of the operating system. See Editing an Active Fingerprint for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1977816]You must specify a Vendor and Product name in this section if you want to use the fingerprint to identify vulnerabilities for matching hosts or if you do not assign custom operating system display information. To map vulnerabilities for all versions of an operating system, specify only the vendor and product name. For example, to add all versions of the Palm OS, you would select PalmSource, Inc. from the Vendor list, Palm OS from the Product list, and leave all other lists at their default settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-1977727]Note Not all options in the Major Version, Minor Version, Revision Version, Build, Patch, and Extension drop-down lists may apply to the operating system you choose. In addition, if no definition appears in a list that matches the operating system you want to fingerprint, you can leave these values empty. Be aware that if you do not create any OS vulnerability mappings in a fingerprint, the system cannot use the fingerprint to assign a vulnerabilities list with hosts identified by the fingerprint.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1430104]Step 12 Click Create.
 
     [bookmark: pgfId-1430105]The Custom Fingerprint status page reappears. The status page refreshes every ten seconds until it receives data from the host in question.
 
      
       
     
 
     
 
     [bookmark: pgfId-1430106]Tip When you click Create, the status briefly shows New, then switches to Pending, where it remains until traffic is seen for the fingerprint, then the status switches to Ready.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1430107]Step 13 Using the IP address you specified as the target IP address, access the host you are trying to fingerprint and initiate a TCP connection to the appliance.
 
     [bookmark: pgfId-1430117]For example, access the web interface of the Defense Center from the host you want to fingerprint or SSH into the Defense Center from the host. If you are using SSH, use the following command:
 
      
      [bookmark: pgfId-2057434]ssh -b localIPv6address DCmanagementIPv6address 
     
 
     [bookmark: pgfId-2057462]where localIPv6address is the IPv6 address specified in step 7 that is currently assigned to the host and DCmanagementIPv6address is the management IPv6 address of the Defense Center.
 
     [bookmark: pgfId-2057428]The Custom Fingerprint page should then reload with a “Ready” status.
 
      
       
     
 
     
 
     [bookmark: pgfId-1596317]Note To create an accurate fingerprint, traffic must be seen by the appliance collecting the fingerprint. If you are connected through a switch, traffic to a system other than the appliance may not be seen by the system.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1430147]Step 14 After the fingerprint is created, you must activate it before the Defense Center can use it to identify hosts. See Managing Fingerprints for more information.
 
     [bookmark: pgfId-2093137]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1430165][bookmark: 53724]Fingerprinting Ser[bookmark: marker-1430164]vers
 
     [bookmark: pgfId-1898384]License: FireSIGHT
 
     [bookmark: pgfId-1430173]Server fingerprints identify operating systems based on the SYN-ACK packet that the host uses to respond to an incoming connection to a running TCP application. Before you begin, you should obtain the following information about the host you want to fingerprint:
 
      
      	 [bookmark: pgfId-1430177]The number of network hops between the host and the appliance you use to obtain the fingerprint. Cisco strongly recommends that you directly connect an unused interface on the appliance to the same subnet that the host is connected to.
 
      	 [bookmark: pgfId-1430196]The network interface (on the appliance) that is connected to the network where the host resides.
 
      	 [bookmark: pgfId-1430197]The actual operating system vendor, product, and version of the host.
 
      	 [bookmark: pgfId-1430198]An IP address that is not currently in use and is authorized on the network where the host is located.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1596380]Tip If the Defense Center does not have direct contact with monitored hosts, you can specify a managed device that is closest to the host you intend to fingerprint when specifying server fingerprint properties.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1430216]To obtain a server fingerprint for a host:
 
     [bookmark: pgfId-2100067]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1921060]Step 1 Select Policies > Network Discovery, then click Custom Operating Systems.
 
     [bookmark: pgfId-1430218]The Custom Fingerprint page appears.
 
     [bookmark: pgfId-1430219]Step 2 Click Create Custom Fingerprint.
 
     [bookmark: pgfId-1430220]The Create Custom Fingerprint page appears.
 
     [bookmark: pgfId-1430232]Step 3 [bookmark: 86389]From the Device list, select the Defense Center or the managed device that you want to use to collect the fingerprint.
 
     [bookmark: pgfId-1430238]Step 4 [bookmark: 67191]In the Fingerprint Name field, type an identifying name for the fingerprint.
 
     [bookmark: pgfId-1430243]Step 5 In the Fingerprint Description field, type a description for the fingerprint.
 
     [bookmark: pgfId-1430244]Step 6 From the Fingerprint Type list, select Server.
 
     [bookmark: pgfId-1430245]Server fingerprinting options appear.
 
     [bookmark: pgfId-1430250]Step 7 In the Target IP Address field, type an IP address of the host you want to fingerprint. Note that the fingerprint will only be based on traffic to and from the host IP address you specify, not any of the host’s other IP addresses (if it has any).
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2054147] 
      Caution You can capture IPv6 fingerprints only with appliances running Version 5.2 and later of the FireSIGHT System. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1430251]Step 8 In the Target Distance field, enter the number of network hops between the host and the device that you selected in step 3 to collect the fingerprint.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1430255] 
      Caution This must be the actual number of physical network hops to the host, which may or may not be the same as the number of hops detected by the system. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1430259]Step 9 From the Interface list, select the network interface that is connected to the network segment where the host resides.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1596421] 
      Caution Cisco recommends that you do 
      not use the sensing interface on a managed device for fingerprinting for several reasons. First, fingerprinting does not work if the sensing interface is on a span port. Also, if you use the sensing interface on a device, the device stops monitoring the network for the amount of time it takes to collect the fingerprint. You can, however, use the management interface or any other available network interfaces to perform fingerprint collection. If you do not know which interface is the sensing interface on your device, refer to the 
      Installation Guide for the specific model you are using to fingerprint. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1430267]Step 10 Click Get Active Ports.
 
     [bookmark: pgfId-1430271]If the system has detected any open ports on the host, they appear in the drop-down list.
 
     [bookmark: pgfId-1430272]Step 11 In the Server Port field, type the port that you want the device selected to collect the fingerprint to initiate contact with, or select a port from the Get Active Ports drop-down list.
 
     [bookmark: pgfId-1430273]You can use any server port that you know is open on the host (for instance, 80 if the host is running a web server).
 
     [bookmark: pgfId-1430274]Step 12 In the Source IP Address field, type an IP address that should be used to attempt to communicate with the host.
 
     [bookmark: pgfId-1430279]You should use a source IP address that is authorized for use on the network but is not currently being used, for example, a DHCP pool address that is currently not in use. This prevents you from temporarily knocking another host offline while you create the fingerprint.
 
     [bookmark: pgfId-1430283]In addition, you should exclude that IP address from monitoring in your network discovery policy while you create the fingerprint. Otherwise, the network map and discovery event views will be cluttered with inaccurate information about the host represented by that IP address. For more information, see Understanding Discovery Data Collection.
 
     [bookmark: pgfId-1430290]Step 13 In the Source Subnet Mask field, type the subnet mask for the IP address you are using.
 
     [bookmark: pgfId-1430291]Step 14 If the Source Gateway field appears, enter the default gateway IP address that should be used to establish a route to the host.
 
     [bookmark: pgfId-1430292]The Source Gateway field appears if the target distance (number of hops) is 1 or higher and you are using an interface other than the management interface to connect to the network where the host resides.
 
     [bookmark: pgfId-1430293]Step 15 If you want to display custom information in the host profile for fingerprinted hosts or if the fingerprint name you want to use does not exist in the OS Definition section, select Use Custom OS Display in the Custom OS Display section.
 
     [bookmark: pgfId-1430298]Provide the values you want to appear in host profiles for the following:
 
      
       
       	 [bookmark: pgfId-1430299]In the  Vendor String field, type the operating system’s vendor name. For example, the vendor for Microsoft Windows would be Microsoft.
 
       	 [bookmark: pgfId-1430300]In the  Product String field, type the operating system’s product name. For example, the product name for Microsoft Windows 2000 would be Windows.
 
       	 [bookmark: pgfId-1430301]In the  Version String field, type the operating system’s version number. For example, the version number for Microsoft Windows 2000 would be 2000.
 
      
 
     
 
     [bookmark: pgfId-1430303]Step 16 In [bookmark: marker-1430302]the OS Vulnerability Mappings section, select the operating system, product, and versions you want to use for vulnerability mapping. For example, if you want your custom fingerprint to assign the list of vulnerabilities from Redhat Linux 9 to matching hosts, select Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the version.
 
      
       
     
 
     
 
     [bookmark: pgfId-1430317]Tip When creating a fingerprint, you assign a single vulnerability mapping for the fingerprint. After the fingerprint is created and activated, you can add additional vulnerability mappings for other versions of the operating system. See Editing an Active Fingerprint for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1430321]You must specify a Vendor and Product name in this section if you want to use the fingerprint to identify vulnerabilities for matching hosts or if you do not assign custom operating system display information. To map vulnerabilities for all versions of an operating system, specify only the vendor and product name. For example, to add all versions of the Palm OS, you would select PalmSource, Inc. from the Vendor list, Palm OS from the Product list, and leave all other lists at their default settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-1430322]Note Not all options in the Major Version, Minor Version, Revision Version, Build, Patch, and Extension drop-down lists may apply to the operating system you choose. In addition, if no definition appears in a list that matches the operating system you want to fingerprint, you can leave these values empty. Be aware that if you do not create any OS vulnerability mappings in a fingerprint, the system cannot use the fingerprint to assign a vulnerabilities list with hosts identified by the fingerprint.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1430331]Step 17 Click Create.
 
     [bookmark: pgfId-1494670]Step 18 The Custom Fingerprint status page appears. It reloads every ten seconds and should reload with a “Ready” status. 
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1430334]Step 19 After the fingerprint is created, activate it and, optionally, add vulnerability mappings. See Managing Fingerprints for more information.
 
    [bookmark: pgfId-2093220]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1430352][bookmark: 14015]Managing[bookmark: marker-1430351] Fingerprints
 
    [bookmark: pgfId-1898402]License: FireSIGHT
 
    [bookmark: pgfId-1430360]You can activate, deactivate, delete, view, and edit custom fingerprints. When creating a fingerprint, you assign a single vulnerability mapping for the fingerprint. For more information on creating a fingerprint, see Fingerprinting Clients and Fingerprinting Servers. After the fingerprint is created and activated, you can edit the fingerprint to make changes or add vulnerability mappings.
 
    [bookmark: pgfId-1430367]To access the Custom Fingerprints page:
 
    [bookmark: pgfId-2100094]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1921082]Step 1 Select Policies > Network Discovery, then click Custom Operating Systems.
 
    [bookmark: pgfId-1632582]The Custom Fingerprint page appears.
 
    [bookmark: pgfId-1430374]If the system is awaiting data to create a fingerprint, it automatically refreshes the page every 10 seconds until the fingerprint is created.
 
    [bookmark: pgfId-2093258]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1430375]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1430379]Activating Fingerprints
 
     	 [bookmark: pgfId-1430383]Deactivating Fingerprints
 
     	 [bookmark: pgfId-1430387]Deleting Fingerprints
 
     	 [bookmark: pgfId-1430391]Editing Fingerprints
 
    
 
   
 
    
     [bookmark: pgfId-1430406][bookmark: 99574]Activating [bookmark: marker-1430405]Fingerprints
 
    [bookmark: pgfId-1898426]License: FireSIGHT
 
    [bookmark: pgfId-1430410]After creating a custom fingerprint, you must activate it before the system can use it to identify hosts. After the new fingerprint is activated, the system uses it to re-identify previously discovered hosts and discover new hosts.
 
    [bookmark: pgfId-1430414]To activate a fingerprint:
 
    [bookmark: pgfId-2100113]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1921104]Step 1 Select Policies > Network Discovery, then click Custom Operating Systems.
 
    [bookmark: pgfId-1430416]The Custom Fingerprint page appears.
 
    [bookmark: pgfId-1494543]Step 2 Click the slider next to the fingerprint you want to activate.
 
     
      
    
 
    
 
    [bookmark: pgfId-1430425]Note The activate option is only available if the fingerprint you created is valid. If the slider is not available, try creating the fingerprint again. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1494929]The Defense Center activates the fingerprint and propagates it to all managed devices. The icon next to the fingerprint name changes to indicate that the fingerprint is active.
 
    [bookmark: pgfId-2093298]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1430447][bookmark: 53762]Deactivating [bookmark: marker-1430446]Fingerprints
 
    [bookmark: pgfId-1898451]License: FireSIGHT
 
    [bookmark: pgfId-1430448]If you want to stop using a fingerprint, you can deactivate it. Deactivating a fingerprint causes a fingerprint to no longer be used, but allows it to remain on the system. When you deactivate a fingerprint, the operating system is marked as unknown for hosts that use the fingerprint. If the hosts are detected again and match a different active fingerprint, they are then identified by that active fingerprint.
 
    [bookmark: pgfId-1430449]Deleting a fingerprint removes it from the system completely. After deactivating a fingerprint, you can delete it.
 
    [bookmark: pgfId-1430450]To deactivate an active fingerprint:
 
    [bookmark: pgfId-2100132]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1921126]Step 1 Select Policies > Network Discovery, then click Custom Operating Systems.
 
    [bookmark: pgfId-1430452]The Custom Fingerprint page appears.
 
    [bookmark: pgfId-2093328]Step 2 Click the slider next to the active fingerprint you want to deactivate.
 
    [bookmark: pgfId-2093332]The Defense Center deactivates the fingerprint and propagates the deactivation to all managed devices.
 
    [bookmark: pgfId-2093350]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1430483][bookmark: 15969]Deleting [bookmark: marker-1430482]Fingerprints
 
    [bookmark: pgfId-1898471]License: FireSIGHT
 
    [bookmark: pgfId-2129849]If you no longer have use for a fingerprint, you can delete it from the system. Note that you must deactivate fingerprints before you can delete them.
 
    [bookmark: pgfId-2129850]To delete a fingerprint:
 
    [bookmark: pgfId-2129854]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-2013630]Step 1 Select Policies > Network Discovery, then click Custom Operating Systems.
 
    [bookmark: pgfId-2013634]The Custom Fingerprint page appears.
 
    [bookmark: pgfId-2013635]Step 2 If the fingerprints you want to delete are active, click the slider icon next to each one to deactivate it.
 ) next to the fingerprint you want to delete. 
    
 
    [bookmark: pgfId-1430494]Step 4 Click OK to confirm that you want to delete the fingerprint.
 
    [bookmark: pgfId-1430495]The fingerprint is deleted.
 
    [bookmark: pgfId-2093367]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1430514][bookmark: 12545]Editing Fi  [bookmark: marker-1506404]ngerprints
 
    [bookmark: pgfId-1898492]License: FireSIGHT
 
    [bookmark: pgfId-1430515]After you create a fingerprint, you can view or edit it. This allows you to make changes and resubmit the fingerprint or add additional vulnerability mappings to it. You can modify fingerprints whether they are active or inactive, but depending on a fingerprint’s state, the things that can be modified differ.
 
    [bookmark: pgfId-1430516]If a fingerprint is inactive, you can modify all elements of the fingerprint and resubmit it to the Defense Center. This includes all properties you specified when creating the fingerprint, such as fingerprint type, target IP addresses and ports, vulnerability mappings, and so on. When you edit an inactive fingerprint and submit it, it is resubmitted to the system and, if it is a client fingerprint, you must resend traffic to the appliance before activating it. Note that you can select only a single vulnerability mapping for an inactive fingerprint. After you activate the fingerprint, you can map additional operating systems and versions to its vulnerabilities list.
 
    [bookmark: pgfId-1430526]If a fingerprint is active, you can modify the fingerprint name, description, custom operating system display, and map additional vulnerabilities to it. 
 
    [bookmark: pgfId-1430527]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1430531]Editing an Inactive Fingerprint
 
     	 [bookmark: pgfId-1430535]Editing an Active Fingerprint
 
    
 
   
 
    
     [bookmark: pgfId-1430553][bookmark: 50768]Editing an Inactive Fingerprint
 
    [bookmark: pgfId-1898508]License: FireSIGHT
 
    [bookmark: pgfId-1430554]If a fingerprint is inactive, you can modify its properties and resubmit it to the system. This includes making changes such as the type of fingerprint to use, the target system to fingerprint, and so on. 
 
    [bookmark: pgfId-1430555]To edit inactive fingerprints:
 
    [bookmark: pgfId-2100162]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1921163]Step 1 Select Policies > Network Discovery, then click Custom Operating Systems.
 
    [bookmark: pgfId-1430557]The Custom Fingerprint page appears.
 ) next to the fingerprint you want to edit. 
    
 
    [bookmark: pgfId-1430559]The Edit Custom Fingerprint page appears.
 
    [bookmark: pgfId-1430560]Step 3 Make changes to the fingerprint as necessary:
 
     
      
      	 [bookmark: pgfId-1430563]If you are modifying a client fingerprint, see Fingerprinting Clients for more information about the options you can configure.
 
      	 [bookmark: pgfId-1430567]If you are modifying a server fingerprint, see Fingerprinting Servers for more information about the options you can configure.
 
     
 
    
 
    [bookmark: pgfId-1430569]Step 4 Click Save to resubmit the fingerprint.
 
     
      
    
 
    
 
    [bookmark: pgfId-1430570]Note If you modified a client fingerprint, remember to send traffic from the host to the appliance gathering the fingerprint.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2093381]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1430586][bookmark: 41555]Editing an Active Fingerprint
 
    [bookmark: pgfId-1898524]License: FireSIGHT
 
    [bookmark: pgfId-1430587]When a fingerprint is active, you can change its name, description, and display label. In addition, you can manage vulnerability mappings, including adding and deleting vulnerability mappings.
 
    [bookmark: pgfId-1430588]To edit active fingerprints:
 
    [bookmark: pgfId-2100181]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1921179]Step 1 Select Policies > Network Discovery, then click Custom Operating Systems.
 
    [bookmark: pgfId-1925749]The Custom Fingerprint page appears.
 ) next to the fingerprint you want to edit. 
    
 
    [bookmark: pgfId-1925751]The Edit Custom Fingerprint Product Mappings page appears.
 
    [bookmark: pgfId-1430593]Step 3 Modify the fingerprint name, description, and custom OS display, if necessary.
 
    [bookmark: pgfId-1430594]Step 4 If you want to delete a vulnerability mapping, click Delete next to the mapping in the Pre-Defined OS Product Maps section of the page.
 
    [bookmark: pgfId-1430595]Step 5 If you want to add additional operating systems for vulnerability mapping, select the Product and, if applicable, the Major Version, Minor Version, Revision Version, Build, Patch, and Extension and then click Add OS Definition.
 
    [bookmark: pgfId-1430596]The vulnerability mapping is added to the Pre-Defined OS Product Maps list.
 
    [bookmark: pgfId-1804942]Step 6 Click Save to save your changes.
 
    [bookmark: pgfId-2093449]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1805065][bookmark: 81868]Working with [bookmark: marker-1805062][bookmark: marker-1805063]Application Detectors
 
    [bookmark: pgfId-1898541]License: FireSIGHT
 
    [bookmark: pgfId-1838811]When the FireSIGHT System analyzes IP traffic, it uses detectors to identify the commonly used applications on your network. You use the Detectors page (Policies > Application Detectors) to customize the detection capability of the FireSIGHT System.
 
    [bookmark: pgfId-1838823]The page provides information about each detector, including:
 
     
     	 [bookmark: pgfId-2001317]the name of the detector
 
     	 [bookmark: pgfId-2001318]the protocol (TCP, UDP, or both) of traffic that the detector inspects
 
     	 [bookmark: pgfId-2001319]whether the type of the detector is application protocol, client, web application, or internal detector
 
     	 [bookmark: pgfId-2001320]for port-based application detectors, the port used by the application traffic 
 
     	 [bookmark: pgfId-2001321]details regarding the detected application, including the name, description, risk, business relevance, tags, and categories associated with the application detected by the detector
 
     	 [bookmark: pgfId-2001322]the state (active or inactive) of the detector
 
    
 
    [bookmark: pgfId-1942539]The system uses only active detectors to analyze application traffic.
 
    [bookmark: pgfId-1838848]You may notice that the listed detectors have different properties. For example, you can view the settings for some detectors but not others. Similarly, you can delete some detectors but not others. This is because there are several different types of Cisco-provided detectors, as described in the following sections.
 
    [bookmark: pgfId-1950025]Cisco-Provided Internal Detectors
 
    [bookmark: pgfId-1965843]Internal detectors are application detectors that are only delivered with updates to the FireSIGHT System. Internal detectors detect client, web application, or application protocol traffic, depending on the detector, but they are categorized as internal detectors rather than one of the other types because they are built-in detectors and cannot be deactivated.
 
    [bookmark: pgfId-1952415]Internal detectors are always on; you cannot deactivate, delete, or otherwise configure them. Examples of internal detectors are the Built-in Amazon detector and the Built-in AppleTalk detector.
 
    [bookmark: pgfId-1950239]Cisco-Provided Client Detectors
 
    [bookmark: pgfId-1950261]Cisco-provided client detectors, which detect client traffic, are delivered via VDB updates but may also be provided with updates to the FireSIGHT System. These detectors may also be provided by Cisco Professional Services as an importable detector.
 
    [bookmark: pgfId-1954257]You can activate and deactivate client detectors according to the needs of your organization. VDB updates may also activate or deactivate client detectors. You can export a client detector only if you import it.
 
    [bookmark: pgfId-1950455]The Google Earth and Immunet detectors are examples of client detectors.
 
    [bookmark: pgfId-1950508]Cisco-Provided Web Application Detectors
 
    [bookmark: pgfId-1950521]Cisco-provided web application detectors, which detect web applications in payloads of HTTP traffic, are delivered via VDB updates but may also be provided with updates to the FireSIGHT System.
 
    [bookmark: pgfId-1950862]You can activate and deactivate web application detectors according to the needs of your organization. VDB updates may activate or deactivate web application detectors. Examples of web application detectors are the Blackboard and LiveJournal detectors.
 
    [bookmark: pgfId-1951086]Cisco-Provided Application Protocol (Port) Detectors
 
    [bookmark: pgfId-1951356]Port-based application protocol detectors, provided by Cisco, are based on detection of network traffic on well-known ports. These detectors are delivered via VDB updates but may also be provided with updates to the FireSIGHT System or provided by Cisco Professional Services as an importable detector. 
 
    [bookmark: pgfId-1994841]You can activate and deactivate application protocol detectors according to the needs of your organization. You can also view a detector definition to use it as the basis for a custom detector. VDB updates may activate or deactivate application protocol detectors.
 
    [bookmark: pgfId-1951088]The chargen and finger detectors are examples of port detectors. 
 
    [bookmark: pgfId-1951093]Cisco-Provided Application Protocol (FireSIGHT) Detectors
 
    [bookmark: pgfId-1951888]FireSIGHT-based application protocol detectors, provided by Cisco, are based on detection of network traffic using FireSIGHT application fingerprints. These detectors are delivered via VDB updates but may also be provided with updates to the FireSIGHT System. 
 
    [bookmark: pgfId-1951094]You can activate and deactivate application protocol detectors according to the needs of your organization. VDB updates may activate or deactivate Cisco-provided application protocol detectors. Examples of FireSIGHT-based application protocol detectors are the Jabber and Steam detectors.
 
    [bookmark: pgfId-1952378]Application Protocol (Pattern) Detectors 
 
    [bookmark: pgfId-1952379]Pattern-based application detectors are based on detection of patterns in packets from network traffic. These detectors can be provided by Cisco Professional Services as an importable detector or created by you. This allows you to enhance the system’s detection capabilities with new pattern-based detectors without updating the FireSIGHT System as a whole.
 
    [bookmark: pgfId-1952383]You can activate and deactivate application protocol detectors according to the needs of your organization. 
 
    [bookmark: pgfId-1952384]You have full control over imported and user-defined detectors; you can activate, deactivate, edit, import, export, and delete them. An example of a pattern-based detector is a user-defined detector using a pattern in the packet header to detect traffic for a custom application. 
 
    [bookmark: pgfId-1838937]Keep in mind that the detector list may change depending on the version of the FireSIGHT System and the VDB you have installed, as well as on any individual detectors you may have imported or created. You should carefully read the release notes for each FireSIGHT System update as well as the advisories for each VDB update for information on updated detectors.
 
    [bookmark: pgfId-1805297]For more information, see:
 
     
     	 [bookmark: pgfId-1805301]Understanding Application Detection
 
     	 [bookmark: pgfId-1805305]Creating a User-Defined Application Protocol Detector
 
     	 [bookmark: pgfId-1805309]Managing Detectors
 
    
 
     
      [bookmark: pgfId-1805411][bookmark: 71632]Creat[bookmark: marker-1805409]ing a User-Defined [bookmark: marker-2013803][bookmark: marker-2013808][bookmark: marker-2013813][bookmark: marker-2013818]Application Protocol Detector
 
     [bookmark: pgfId-1898589]License: FireSIGHT
 
     [bookmark: pgfId-1805420]If you use custom applications on your network, you can create user-defined application protocol detectors that provide the system with the information it needs to identify those applications. You can base application protocol detection on the port or ports used by application traffic, patterns within the traffic, or on both ports and patterns. 
 
     [bookmark: pgfId-1805424]For example, if you expect traffic for a custom application protocol to use port 1180, you can create an application protocol detector that detects traffic on that port. As another example, if you know that the header for any packet containing application protocol traffic has a string of ApplicationName in it, you can create a detector that registers the ASCII string of ApplicationName as a pattern to match.
 
     [bookmark: pgfId-2125591]You can create user-defined application detectors only for application protocols, not for clients or for web applications. For an explanation of each, see Understanding Application Detection. Client sessions must include a responder packet from the server for the system to begin detecting and identifying application protocols in server traffic. Note that, for UDP traffic, the system designates the source of the responder packet as the server. 
 
     [bookmark: pgfId-1805425]User-defined application protocol detectors must use either a port or a pattern match; you cannot create a detector that uses neither, even if you base the detector on an existing detector. You can also create a detector that uses both criteria; this increases the likelihood of correctly identifying traffic for that application protocol. 
 
      
       
     
 
     
 
     [bookmark: pgfId-1839085]Tip If you have already created a detector on another Defense Center, you can export it and then import it onto this Defense Center. You can then edit the imported detector to suit your needs. You can export and import user-defined detectors as well as detectors provided by Cisco Professional Services. However, you cannot export or import any other type of Cisco-provided detectors. For more information, see Importing and Exporting Configurations.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1805468]To create a user-defined application protocol detector:
 
     [bookmark: pgfId-2100196]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1805476]Step 1 Select Policies > Application Detectors.
 
     [bookmark: pgfId-1805480]The Detectors page appears.
 
     [bookmark: pgfId-1805481]Step 2 Click Create Detector.
 
     [bookmark: pgfId-1839109]The Create Detector page appears.
 
     [bookmark: pgfId-1805498]Step 3 Provide basic detector information, such as the detector name and description.
 
     [bookmark: pgfId-1805502]See Providing Basic Application Protocol Detector Information.
 
     [bookmark: pgfId-1937545]Step 4 Optionally, create a user-defined application for the detector.
 
     [bookmark: pgfId-1937644]See Creating a User-Defined Application.
 
     [bookmark: pgfId-1805503]Step 5 Provide detection criteria, including the protocol of traffic the detector should inspect and the port that the traffic uses.
 
     [bookmark: pgfId-1805507]See Specifying Detection Criteria for Application Protocol Detectors.
 
     [bookmark: pgfId-1805508]Step 6 Optionally, configure the detector to inspect traffic for matches to one or more patterns that occurs in traffic for that application protocol.
 
     [bookmark: pgfId-1805512]See Adding Detection Patterns to an Application Protocol Detector.
 
     [bookmark: pgfId-1805513]Step 7 Optionally, test the new detector against the contents of one or more PCAP files.
 
     [bookmark: pgfId-1805517]See Testing an Application Protocol Detector Against Packet Captures.
 
     [bookmark: pgfId-1805519]Step 8 [bookmark: 70277]Click Save.
 
     [bookmark: pgfId-1805520]The application protocol detector is saved.
 
      
       
     
 
     
 
     [bookmark: pgfId-2093469]Note You must activate the detector before the system can use it to analyze application protocol traffic. For more information, see Activating and Deactivating Detectors. Note that if you include the application in an access control rule, the detector is automatically activated and cannot be deactivated while in use.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2093481]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2093475][bookmark: 37959]Providing Basic Application Protocol Detector Information
 
     [bookmark: pgfId-1898606]License: FireSIGHT
 
     [bookmark: pgfId-1805539]You must give each user-defined application protocol detector a name, as well as identify the application protocol you want to detect. Optionally, you can provide a brief description of the detector.
 
     [bookmark: pgfId-1805543]In addition to the information you provide, the Defense Center indicates whether the detector is active or inactive, and whether the detector is a port or pattern detector. If a detector identifies application protocol traffic by port and pattern, the FireSIGHT System considers it a pattern detector.
 
     [bookmark: pgfId-1839138]If you are editing an existing detector, the Defense Center also displays the detector’s author. If you created a user-defined application protocol detector, you are the author. You are also the author for any detector that you import or that you edit and save.
 
     [bookmark: pgfId-1805563]To provide basic application protocol detector information:
 
     [bookmark: pgfId-2100211]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1805565]Step 1 On the Create Detector page, in the Please enter a name field, type a name for the detector.
 
     [bookmark: pgfId-1805566]Detector names must be unique within the protocol for the traffic you are inspecting. That is, you can create a TCP detector and a UDP detector with the same name, but you cannot create two TCP detectors with the same name.
 
     [bookmark: pgfId-1805567]Step 2 Identify the application protocol you want to detect. You have the following options:
 
      
       
       	 [bookmark: pgfId-1805568]If you are creating a detector for an existing application protocol (for example, if you want to detect a particular application protocol on a non-standard port), select the application protocol from the  Application Protocol  drop-down list. Continue with the procedure in Specifying Detection Criteria for Application Protocol Detectors.
 
       	 [bookmark: pgfId-1940113]If you are creating a detector for a custom application, continue with the procedure in the next section, Creating a User-Defined Application.
 
      
 
     
 
     [bookmark: pgfId-2093496]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1940123][bookmark: 58874]Creating a User-Defined Application
 
     [bookmark: pgfId-1940124]License: FireSIGHT
 
     [bookmark: pgfId-1937690]You can create a user-defined application to identify a custom application on your network. You can also create custom categories and custom tags to describe the application. Applications, categories, and tags created here are available in access control rules and in the application filter object manager as well. 
 
     [bookmark: pgfId-2001423]For more information on application detection, including a discussion of application protocols and the categories, tags, risk levels, and business relevance used to describe them, see Understanding Application Detection.
 
     [bookmark: pgfId-1936996]To create a user-defined application:
 
     [bookmark: pgfId-2100226]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1938025]Step 1 On the Create Detector page, click Add.
 
     [bookmark: pgfId-1938166]The Application Editor pop-up window appears.
 
     [bookmark: pgfId-1939056]Step 2 Type a Name for the custom application. 
 
     [bookmark: pgfId-1939127]Step 3 Type a Description for the custom application.
 
     [bookmark: pgfId-1939258]Step 4 Select a Business Relevance. 
 
     [bookmark: pgfId-1939308]Step 5 Select a Risk. 
 
     [bookmark: pgfId-1939329]Step 6 Click Add next to Categories to add a category and type a new category name or select an existing category from the Categories drop-down list.
 
     [bookmark: pgfId-1939729]Step 7 Optionally, click Add next to Tags to add a tag and type a new tag name or select an existing tag from the Tags drop-down list.
 
     [bookmark: pgfId-1939842]Click OK to return to the Create Detector page.
 
     [bookmark: pgfId-1939954]Step 8 Continue with the procedure in the next section, Specifying Detection Criteria for Application Protocol Detectors.
 
     [bookmark: pgfId-2093508]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1805584][bookmark: 12415]Specifying Detection Criteria for Application Protocol Detectors
 
     [bookmark: pgfId-1898624]License: FireSIGHT
 
     [bookmark: pgfId-1805592]When creating a user-defined application protocol detector, you must specify the protocol of traffic (TCP, UDP, or both) the detector should inspect. Optionally, you can specify a port that the traffic uses.
 
     [bookmark: pgfId-1805597]Note that if you do not specify a port, you must configure the detector to inspect traffic for matches to one or more patterns, as described in Adding Detection Patterns to an Application Protocol Detector.
 
     [bookmark: pgfId-1805601]To specify detection criteria for an application protocol detector:
 
     [bookmark: pgfId-2100241]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1805603]Step 1 On the Create Detector page, from the Protocol drop-down list, select the protocol for traffic the detector should inspect. 
 
     [bookmark: pgfId-1805604]Detectors can inspect TCP, UDP, or TCP and UDP traffic.
 
     [bookmark: pgfId-1805605]Step 2 Optionally, to identify application protocol traffic based on the port it uses, type a port from 1 to 65535 in the Port(s) field. To use multiple ports, separate them by commas.
 
     [bookmark: pgfId-1805606]Step 3 You have the following options:
 
      
       
       	 [bookmark: pgfId-1805607]If you want to configure the application protocol detector to inspect traffic for matches to one or more patterns that occurs in traffic for that application protocol, continue with the procedure in the next section, Adding Detection Patterns to an Application Protocol Detector.
 
       	 [bookmark: pgfId-1805611]If you want to test the new detector against the contents of one or more PCAP files, skip to Testing an Application Protocol Detector Against Packet Captures.
 
       	 [bookmark: pgfId-1805615]If you are done creating the detector, click  Save .
 
      
 
     
 
     [bookmark: pgfId-1805616]The application protocol detector is saved.
 
     [bookmark: pgfId-1805620]Note that you must activate the detector before the system can use it to analyze application protocol traffic. For more information, see Activating and Deactivating Detectors.
 
     [bookmark: pgfId-2093520]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1805625][bookmark: 28073]Adding Detection Patterns to an Application Protocol Detector
 
     [bookmark: pgfId-1898641]License: FireSIGHT
 
     [bookmark: pgfId-1805634]If you know that the header for any packet containing application protocol traffic contains a particular pattern string, you can configure a user-defined application protocol detector to search for that pattern. 
 
     [bookmark: pgfId-1805635]Application protocol detectors can search for ASCII or hexadecimal patterns, using any offset. You can also configure detectors to search for multiple patterns; in that case the application protocol traffic must match all of the patterns for the detector to positively identify the application protocol.
 
     [bookmark: pgfId-1805640]Note that if you do not specify a pattern, you must configure the detector to inspect traffic that uses one or more ports, as described in Specifying Detection Criteria for Application Protocol Detectors.
 
     [bookmark: pgfId-1805644]To add a detection pattern to an application protocol detector:
 
     [bookmark: pgfId-2100256]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1805647]Step 1 [bookmark: 51909]On the Create Detector page, in the Detection Patterns section, click Add.
 
     [bookmark: pgfId-1968949]The Add Pattern pop-up window appears.
 
     [bookmark: pgfId-1805648]Step 2 Specify the pattern type you want to detect: Ascii or Hex.
 
     [bookmark: pgfId-1805649]Step 3 Type a string of the type you specified in the Pattern String field.
 
     [bookmark: pgfId-1805654]Step 4 [bookmark: 43055]Optionally, specify where in a packet the system should begin searching for the pattern; this is called the offset.
 
     [bookmark: pgfId-1805655]Type the offset (in bytes from the beginning of the packet payload) in the Offset field.
 
     [bookmark: pgfId-1805656]Because packet payloads start at byte 0, calculate the offset by subtracting 1 from the number of bytes you want to move forward from the beginning of the packet payload. For example, to look for the pattern in the fifth bit of the packet, type 4 in the Offset field.
 
     [bookmark: pgfId-1805663]Step 5 Optionally, repeat steps 1 to 4 to add additional patterns.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1805665]Step 6 You have the following options:
 
     
      
      	 [bookmark: pgfId-1805666]If you want to test the new detector against the contents of one or more PCAP files, continue with the procedure in the next section, Testing an Application Protocol Detector Against Packet Captures.
 
      	 [bookmark: pgfId-1805670]If you are done creating the detector, click  Save .
 
     
 
    
 
    [bookmark: pgfId-1805671]The application protocol detector is saved.
 
     
      
    
 
    
 
    [bookmark: pgfId-2063118]Note You must activate the detector before the system can use it to analyze application protocol traffic. For more information, see Activating and Deactivating Detectors.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2093571]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1805681][bookmark: 66170]Testing an Application Protocol Detector Ag[bookmark: marker-1959477]ainst Packet Captures
 
    [bookmark: pgfId-1898657]License: FireSIGHT
 
    [bookmark: pgfId-1805690]If you have a packet capture (PCAP) file that contains packets with traffic from the application protocol you want to detect, you can test a user-defined application protocol detector against that PCAP file. Note that PCAP files must be 32KB or smaller; if you try to test your detector against a larger PCAP file, the Defense Center automatically truncates it.
 
    [bookmark: pgfId-1805694]To test an application protocol detector against a PCAP file:
 
    [bookmark: pgfId-2100271]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1805697]Step 1 [bookmark: 14035]On the Create Detector page, in the Packet Captures section, click Add.
 
    [bookmark: pgfId-1805698]A pop-up window appears.
 
    [bookmark: pgfId-1805703]Step 2 Browse to the PCAP file and click OK.
 
    [bookmark: pgfId-1805704]The PCAP file appears in the Packet Captures file list.
 
    [bookmark: pgfId-1805710]Step 3 [bookmark: 79361]To test your detector against the contents of the PCAP file, click the evaluate icon next to the PCAP file.
 
    [bookmark: pgfId-1805711]A message appears, indicating whether the test succeeded.
 
    [bookmark: pgfId-1949964]Step 4 Optionally, repeat steps 1 to 3 to test the detector against additional PCAP files.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1805720]Step 5 To save the detector, click Save.
 
    
     
   
 
   
 
   [bookmark: pgfId-1805724]Note You must activate the detector before the system can use it to analyze application protocol traffic. For more information, see Activating and Deactivating Detectors.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-2093592]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1805732][bookmark: 87480]Managing Dete[bookmark: marker-1959482]ctors
 
    [bookmark: pgfId-1898674]License: FireSIGHT
 
    [bookmark: pgfId-1839207]You view and manage detectors on the Detectors page.
 
    [bookmark: pgfId-2004111]From the Detectors page, you can:
 
     
     	 [bookmark: pgfId-2004112]view details about the application the detector identifies
 
     	 [bookmark: pgfId-2002408]sort, filter, and browse the list of detectors
 
     	 [bookmark: pgfId-1839220]view a list of the Cisco-provided internal detectors
 
     	 [bookmark: pgfId-1839224]view the properties of the Cisco-provided application protocol port detectors, and optionally save copies as new, user-defined detectors that you can modify
 
     	 [bookmark: pgfId-1839225]create, modify, delete, and export user-defined application protocol detectors
 
     	 [bookmark: pgfId-1839226]delete and export any application protocol detectors you individually imported
 
     	 [bookmark: pgfId-1839228]activate and deactivate user-defined, imported, or Cisco-provided web application, client, and application protocol detectors
 
    
 
    [bookmark: pgfId-1839229]Note that you cannot modify or delete internal or Cisco-provided application protocol, client, or web application detectors and cannot deactivate internal detectors. 
 
    [bookmark: pgfId-1805818]For more information, see:
 
     
     	 [bookmark: pgfId-1805822]Viewing Detector Details
 
     	 [bookmark: pgfId-2000941]Sorting the Detector List
 
     	 [bookmark: pgfId-1805826]Filtering the Detector List
 
     	 [bookmark: pgfId-1805830]Navigating to Other Detector Pages
 
     	 [bookmark: pgfId-1805834]Activating and Deactivating Detectors
 
     	 [bookmark: pgfId-1805838]Modifying Application Detectors
 
     	 [bookmark: pgfId-1969113]Deleting Detectors
 
    
 
   
 
    
     [bookmark: pgfId-2000893][bookmark: 79922]Viewing Detector Details
 
    [bookmark: pgfId-2000897]License: FireSIGHT
 
    [bookmark: pgfId-2000898]You can view more detail on a detector from the application detectors list. 
 
    [bookmark: pgfId-2000899]To view application detector details:
 
    [bookmark: pgfId-2100286]Access: Admin/Discovery Admin
 
    
 ) in the Details column. 
    
 
    [bookmark: pgfId-2000905]The information pop-up window for the detector appears. 
 
    [bookmark: pgfId-2000910]For more information on risk, business relevance, tags, and categories, see Understanding Application Detection.
 
    [bookmark: pgfId-2093654]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1999799][bookmark: 18194]Sorting the Dete[bookmark: marker-1969115]ctor List
 
    [bookmark: pgfId-1969120]License: FireSIGHT
 ) or down arrow next to a column heading indicates that the page is sorted by that column in that direction. 
    
 
    [bookmark: pgfId-1805873]To sort detectors:
 
    [bookmark: pgfId-2100301]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1805875]Step 1 On the Detectors page, click the appropriate column heading.
 
    [bookmark: pgfId-1805876]The detectors are sorted in the direction indicated by the arrow that appears on the column heading. To sort in the opposite direction, click the heading again.
 
    [bookmark: pgfId-2093666]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1805882][bookmark: 76016]Filtering the Dete[bookmark: marker-1805881]ctor List
 
    [bookmark: pgfId-1898729]License: FireSIGHT
 
    [bookmark: pgfId-1997112]You can filter the detectors you display on the Detectors page by a single criterion, or a combination of multiple criteria. The filter you construct is shown at the top of the page. You can use several filter groups, separately or in combination, to filter the list of detectors.
 
    [bookmark: pgfId-2003306]Name
 
    [bookmark: pgfId-2003307]Finds detectors with names or descriptions containing the string you type. Strings can contain any alphanumeric or special character. 
 
    [bookmark: pgfId-2000769]Custom Filter
 
    [bookmark: pgfId-2001968]Finds detectors matching a custom application filter created on the object management page. For more information, see Working with Application Filters.
 
    [bookmark: pgfId-2001981]Author
 
    [bookmark: pgfId-2001973]Finds detectors according to who created the detector. You can filter detectors by:
 
    [bookmark: pgfId-1997234] – any individual user who has created or imported a detector
 
    [bookmark: pgfId-1997241] – Cisco, which represents all Cisco-provided detectors except individually imported add-on detectors; you are the author for any detector that you import
 
    [bookmark: pgfId-1997225] – Any User, which represents all detectors not provided by Cisco
 
    [bookmark: pgfId-2001999]State
 
    [bookmark: pgfId-1997313]Finds detectors according to their state, that is, Active or Inactive. For more information, see Activating and Deactivating Detectors.
 
    [bookmark: pgfId-2002017]Type
 
    [bookmark: pgfId-1997365]Finds detectors according to the detector type: Application Protocol, Web Application, Client, or Internal Detector.
 
    [bookmark: pgfId-1997366]Application protocol detectors have three subtypes you can use to further filter detectors:
 
    [bookmark: pgfId-1997367] – Port application protocol detectors include the Cisco-provided well-known port detectors, as well as any port-based user-defined application detectors.
 
    [bookmark: pgfId-1997371] – Pattern application protocol detectors include pattern-based or port-and-pattern-based user-defined application detectors.
 
    [bookmark: pgfId-1997375] – FireSIGHT application protocol detectors are application protocol fingerprint detectors provided by Cisco that can be activated and deactivated.
 
    [bookmark: pgfId-1997357]For more information on detector types, see Working with Application Detectors.
 
    [bookmark: pgfId-2002039]Protocol
 
    [bookmark: pgfId-1997462]Finds detectors according to which traffic protocol the detector inspects. Detectors can inspect TCP, UDP, or TCP and UDP traffic.
 
    [bookmark: pgfId-2002061]Category
 
    [bookmark: pgfId-2002090]Finds detectors according to the categories assigned to the application they detect.
 
    [bookmark: pgfId-2002101]Tag
 
    [bookmark: pgfId-2002092]Finds detectors according to the tags assigned to the application they detect.
 
    [bookmark: pgfId-2002119]Risk
 
    [bookmark: pgfId-1997644]Finds detectors according to the risks assigned to the application they detect: Very High, High, Medium, Low, and Very Low.
 
    [bookmark: pgfId-2002141]Business Relevance
 
    [bookmark: pgfId-1997698]Finds detectors according to the business relevance assigned to the application they detect: Very High, High, Medium, Low, and Very Low.
 
    [bookmark: pgfId-2000828]To apply a filter:
 
    [bookmark: pgfId-2000829]Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-2000830]Step 1 On the Detectors page, expand the filter group you want to use to filter the detectors. 
 
    [bookmark: pgfId-2004166]Step 2 Type the name or select the specific filter you want to use. To select all filters in a group, right-click the group name and select Check All.
 
    [bookmark: pgfId-2004167]Step 3 Optionally, if the filter you are using has subfilters, select the subfilter to further filter the detectors.
 
    [bookmark: pgfId-2000833]To remove a filter:
 
    [bookmark: pgfId-2100316]Access: Admin/Discovery Admin
 
    
 . 
    
 
    [bookmark: pgfId-2000836]The filter is removed and the results update. 
 
    [bookmark: pgfId-2000837]To remove all filters:
 
    [bookmark: pgfId-2100331]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-2000839]Step 1 Click Clear all next to the list of filters applied to the detectors.
 
    [bookmark: pgfId-2093687]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1994824][bookmark: 64820]Navigating to Other De[bookmark: marker-1994823]tector Pages
 
    [bookmark: pgfId-1994828]License: FireSIGHT
 
    [bookmark: pgfId-1806161]The Detectors page displays 25 detectors at a time. The following table explains how to view additional pages of detectors using the navigation links at the bottom of the page.
 
     
     
 
     
 
     
 
     
 
      
       
       [bookmark: pgfId-2004024]Table 46-1 Navigating Detector Pages 
 
       
       
        
        	 
          
          [bookmark: pgfId-2004028]To... 
         
  
        	 
          
          [bookmark: pgfId-2004030]You can... 
         
  
       
 
        
        	[bookmark: pgfId-2004032]view the next page
  ). 
       
 
        
        	[bookmark: pgfId-2004039]view the previous page
  ). 
       
 
        
        	[bookmark: pgfId-2004046]view a different page
  
        	[bookmark: pgfId-2004048]type the page number and press Enter.
  
       
 
        
        	[bookmark: pgfId-2004050]jump to the last page
  ). 
       
 
        
        	[bookmark: pgfId-2004057]jump to the first page
  ). 
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1806204][bookmark: 33460]Activating and Deactivat[bookmark: marker-1806203]ing Detectors
 
    [bookmark: pgfId-1898778]License: FireSIGHT
 
    [bookmark: pgfId-1806215]You must activate a detector before you can use it to analyze network traffic. By default, all Cisco-provided detectors are activated.
 
    [bookmark: pgfId-1839396]You can activate multiple application detectors for each port to supplement the system’s detection capability.
 
    [bookmark: pgfId-2004009]When you include an application in an access control rule in a policy and that policy is applied, if there is no active detector for that application, one or more detectors automatically activate. Similarly, while an application is in use in an applied policy, you cannot deactivate a detector if deactivating leaves no active detectors for that application. 
 
     
      
    
 
    
 
    [bookmark: pgfId-2004010]Tip For improved performance, deactivate any application protocol, client, or web application detectors you are not interested in.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1806238]To activate or deactivate a detector:
 
    [bookmark: pgfId-2100361]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1806246]Step 1 Select Policies > Application Detectors.
 
    [bookmark: pgfId-1806250]The Detectors page appears.
 
    [bookmark: pgfId-1806251]Step 2 Locate the detector you want to activate or deactivate.
 
    [bookmark: pgfId-1806252]If the detector you want to activate or deactivate is not on the first page, you can find it by paging through the detector list or applying one or more filters. For more information, see Managing Detectors.
 
    [bookmark: pgfId-1806256]Step 3 You have the following options:
 
     
      
      	 [bookmark: pgfId-1980804]To  activate a detector, so that the system will use it when analyzing network traffic, click the deactivated slider (
 
     
 
     [image: ] ) next to the detector. 
    
 
     
      
      	 [bookmark: pgfId-1980808]To  deactivate a detector so that the system will not use it when analyzing network traffic, click the activated slider (
 
     
 
     [image: ] ) next to the detector. 
    
 
    [bookmark: pgfId-2003970]Note that some application detectors are required by other detectors. If you deactivate one of these detectors, a warning appears to indicate that the detectors that depend on it are also disabled.
 
    [bookmark: pgfId-2093707]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1806275][bookmark: 59140]Modi[bookmark: marker-1806273]fying Application Detectors
 
    [bookmark: pgfId-1898796]License: FireSIGHT
 
    [bookmark: pgfId-1839421]Use the following procedure to modify user-defined application detectors. 
 
    [bookmark: pgfId-1806307]To modify an application detector:
 
    [bookmark: pgfId-2100384]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1806315]Step 1 Select Policies > Applications.
 
    [bookmark: pgfId-1806319]The Detectors page appears.
 
    [bookmark: pgfId-1806320]Step 2 Locate the detector you want to modify.
 
    [bookmark: pgfId-1806321]If the detector you want to modify is not on the first page, you can find it by paging through the detector list or applying one or more filters. For more information, see Managing Detectors.
 
    [bookmark: pgfId-1806325]Step 3 To modify a user-defined detector, click Edit next to the detector you want to modify.
 
    [bookmark: pgfId-1806332]The Edit Application Detector page appears.
 
    [bookmark: pgfId-1806333]Step 4 Make changes to the detector.
 
    [bookmark: pgfId-1806337]See Creating a User-Defined Application Protocol Detector for information on the various configurations you can change.
 
    [bookmark: pgfId-1806338]Step 5 You have the following options:
 
     
      
      	 [bookmark: pgfId-1806339]If you are modifying an inactive user-defined detector, either click  Save to save your changes, or click  Save as New to save the detector as a new, inactive user-defined detector.
 
      	 [bookmark: pgfId-1806340]If you are modifying an active user-defined detector, either click  Save and Reactivate to save your changes and immediately start using the modified detector, or click  Save as New to save the detector as a new, inactive user-defined detector.
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1806349]Note The system only uses applications with active detectors to analyze application traffic. For more information, see Activating and Deactivating Detectors.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2093727]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1806359][bookmark: 98319]Del[bookmark: marker-1806354]eting Detectors
 
    [bookmark: pgfId-1898812]License: FireSIGHT
 
    [bookmark: pgfId-1935402]Use the following procedure to delete a detector. You can delete user-defined detectors as well as individually imported add-on detectors provided by Cisco Professional Services. You cannot delete any of the other Cisco-provided detectors, though you can deactivate many of them. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1935455]Note While a detector is in use in an applied policy, you cannot deactivate or delete the detector. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1806397]To delete a detector:
 
    [bookmark: pgfId-2100407]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1921259]Step 1 Select Policies > Application Detectors.
 
    [bookmark: pgfId-1921260]The Detectors page appears.
 
    [bookmark: pgfId-1921261]Step 2 Select the check box next to the detector you want to delete and click Delete.
 
    [bookmark: pgfId-1806411]If the detector you want to delete is not on the first page, you can find it by paging through the detector list or applying one or more filters. For more information, see Managing Detectors.
 
    [bookmark: pgfId-1806416]Step 3 Click OK to confirm that you want to delete the detector. 
 
    [bookmark: pgfId-1806417]The detector is deleted.
 
    [bookmark: pgfId-2093754]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1432452][bookmark: 95675]Importing Host [bookmark: marker-1443569]Input Data
 
    [bookmark: pgfId-1898919]License: FireSIGHT
 
    [bookmark: pgfId-1824696]If your organization has the capability to write scripts or create command line import files to import network map data from third parties, you can import data to augment the information in the network map. You can also use the host input feature by modifying operating system or application identities or deleting application protocols, protocols, host attributes, or clients using the web interface.
 
    [bookmark: pgfId-1824703]The system may reconcile data from multiple sources to determine the current identity of an operating system or application. For more information on how the system does this, see Understanding Current Identities. 
 
    [bookmark: pgfId-1604655]Note that all data except third-party vulnerabilities is discarded when the affected host is removed from the network map. For more information on setting up scripts or import files, see the FireSIGHT System Host Input API Guide. 
 
    [bookmark: pgfId-1429466]To include imported data in impact correlations, you must map the data to the operating system and application definitions in the database. For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1429778]Enabling the Use of Third-Party Data
 
     	 [bookmark: pgfId-1957820]Managing Third-Party Product Mappings
 
     	 [bookmark: pgfId-1429782]Mapping Third-Party Vulnerabilities
 
     	 [bookmark: pgfId-1431947]Managing Custom Product Mappings
 
    
 
     
      [bookmark: pgfId-1431948][bookmark: 22435]Enabling the Use of Third-Party Data
 
     [bookmark: pgfId-1898935]License: FireSIGHT
 
     [bookmark: pgfId-1433721]You can import network map data from third-party systems on your network. However, to enable features where intrusion and discovery data are used together, such as FireSIGHT recommendations, adaptive profiles, or impact assessment, you should map as many elements of it as possible to corresponding definitions. Consider the following requirements for using third-party data:
 
      
      	 [bookmark: pgfId-1433710]If you have a third-party system that has specific data on your network assets, you can import that data using the host input feature. However, because third parties may name the products differently, you must map the third-party vendor, product, and versions to the corresponding Cisco product definition. After you map the products, you must enable vulnerability mappings for impact assessment in the system policy to allow impact correlation. For versionless or vendorless application protocols, you need to map vulnerabilities for the application protocols in the system policy. For more information, see Mapping Third-Party Products. 
 
      	 [bookmark: pgfId-1433755]If you import patch information from a third party and you want to mark all vulnerabilities fixed by that patch as invalid, you must map the third-party fix name to a fix definition in the database. All vulnerabilities addressed by the fix will then be removed from hosts where you add that fix. For more information, see Mapping Third-Party Product Fixes.
 
      	 [bookmark: pgfId-1953075]If you import operating system and application protocol vulnerabilities from a third party and you want to use them for impact correlation, you must map the third-party vulnerability identification string to vulnerabilities in the database. Note that although many clients have associated vulnerabilities, and clients are used for impact assessment, you cannot import and map third-party client vulnerabilities. After the vulnerabilities are mapped, you must enable third-party vulnerability mappings for impact assessment in the system policy. For more information, see Mapping Third-Party Vulnerabilities. To cause application protocols without vendor or version information to map to vulnerabilities, an administrative user must also map vulnerabilities for the applications in the system policy. For more information, see Mapping Vulnerabilities for Servers.
 
      	 [bookmark: pgfId-1433788]If you import application data and you want to use that data for impact correlation, you must map the vendor string for each application protocol to the corresponding Cisco application protocol definition. For more information, see Managing Custom Product Mappings.
 
     
 
    
 
     
      [bookmark: pgfId-1431953][bookmark: 54834]Managing Third-Party Pro[bookmark: marker-1957829]duct Mappings
 
     [bookmark: pgfId-1898951]License: FireSIGHT
 
     [bookmark: pgfId-1428682]When you add data from third parties to the network map through the user input feature, you must map the vendor, product, and version names used by the third party to the Cisco product definitions. Mapping the products to Cisco definitions assigns vulnerabilities based on those definitions. 
 
     [bookmark: pgfId-1429204]Similarly, if you are importing patch information from a third party, such as a patch management product, you must map the name for the fix to the appropriate vendor and product and the corresponding fix in the database. 
 
     [bookmark: pgfId-1428736]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1428741]Mapping Third-Party Products
 
      	 [bookmark: pgfId-1957853]Mapping Third-Party Product Fixes
 
     
 
    
 
     
      [bookmark: pgfId-1957857][bookmark: 29649]Mapping [bookmark: marker-1957855]Third-Party Prod[bookmark: marker-1957869]ucts
 
     [bookmark: pgfId-1957862]License: FireSIGHT
 
     [bookmark: pgfId-1426407]If you import data from a third party, you must map the Cisco product to the third-party name to assign vulnerabilities and perform impact correlation using that data. Mapping the product associates Cisco vulnerability information with the third-party product name, which allows the system to perform impact correlation using that data. 
 
     [bookmark: pgfId-1932400]If you import data using the host input import feature, you can also use the AddScanResult function to map third-party products to operating system and application vulnerabilities during the import.
 
     [bookmark: pgfId-1932401]As an example, if you import data from a third party that lists Apache Tomcat as an application and you know it is version 6 of that product, you could add a third-party map where Vendor Name is set to Apache, Product Name is set to Tomcat, Apache is selected from the Vendor drop-down list, Tomcat is selected from the Product drop-down list, and 6 is selected from the Version drop-down list. That mapping would cause any vulnerabilities for Apache Tomcat 6 to be assigned to hosts with an application listing for Apache Tomcat. 
 
     [bookmark: pgfId-1641288]Note that for versionless or vendorless applications, you must map vulnerabilities for the application types in the system policy. For more information, see Mapping Vulnerabilities for Servers. Note that although many clients have associated vulnerabilities, and clients are used for impact assessment, you cannot import and map third-party client vulnerabilities.
 
      
       
     
 
     
 
     [bookmark: pgfId-1856599]Tip If you have already created a third-party mapping on another Defense Center, you can export it and then import it onto this Defense Center. You can then edit the imported mapping to suit your needs. For more information, see Importing and Exporting Configurations.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1426368]To map a third-party product to a Cisco product definition:
 
     [bookmark: pgfId-2100426]Access: Admin
 
     
 
     [bookmark: pgfId-1921337]Step 1 Select Policies > Application Detectors, then click User Third-Party Mappings.
 
     [bookmark: pgfId-1426478]The User Third-Party Mappings page appears.
 
     [bookmark: pgfId-1426479]Step 2 You have two choices:
 
      
       
       	 [bookmark: pgfId-1426480]To edit an existing map set, click  Edit next to the map set.
 
       	 [bookmark: pgfId-1426481]To create a new map set, click  Create Product Map Set .
 
      
 
     
 
     [bookmark: pgfId-1426482]The Edit Third-Party Product Mappings page appears. 
 
     [bookmark: pgfId-1426483]Step 3 Type a name for the mapping set in the Mapping Set Name field.
 
     [bookmark: pgfId-1426484]Step 4 Type a description in the Description field.
 
     [bookmark: pgfId-1426485]Step 5 You have two choices:
 
      
       
       	 [bookmark: pgfId-1426513]To map a third-party product, click  Add Product Map.  
 
       	 [bookmark: pgfId-1426543]To edit an existing third-party product map, click  Edit next to the map set. 
 
      
 
     
 
     [bookmark: pgfId-1427551]The Add Product Map page appears.
 
     [bookmark: pgfId-1431697]Step 6 Type the vendor string used by the third-party product in the Vendor String field.
 
     [bookmark: pgfId-1426440]Step 7 Type the product string used by the third-party product in the Product String field.
 
     [bookmark: pgfId-1426716]Step 8 Type the version string used by the third-party product in the Version String field. 
 
     [bookmark: pgfId-1431743]Step 9 In [bookmark: marker-1431742]the Product Mappings section, select the operating system, product, and versions you want to use for vulnerability mapping from the following lists (if applicable):
 
      
       
       	 [bookmark: pgfId-1431747] Vendor 
 
       	 [bookmark: pgfId-1431748] Product 
 
       	 [bookmark: pgfId-1431749] Major Version 
 
       	 [bookmark: pgfId-1431750] Minor Version 
 
       	 [bookmark: pgfId-1431751] Revision Version 
 
       	 [bookmark: pgfId-1431752] Build 
 
       	 [bookmark: pgfId-1431753] Patch 
 
       	 [bookmark: pgfId-1431754] Extension 
 
      
 
     
 
     [bookmark: pgfId-1431755]For example, if you want a host running a product whose name consists of third-party strings to use the vulnerabilities from Red Hat Linux 9, select Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the version.
 
     [bookmark: pgfId-1426895]Step 10 Click Save.
 
     [bookmark: pgfId-2093779]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1426101][bookmark: 87545]Mapping Third-Party [bookmark: marker-1443582]Product Fixes
 
     [bookmark: pgfId-1898984]License: FireSIGHT
 
     [bookmark: pgfId-1472670]If you map a fix name to a particular set of fixes in the database, you can then import data from a third-party patch management application and apply the fix to a set of hosts. When the fix name is imported to a host, the system marks all vulnerabilities addressed by the fix as invalid for that host.
 
     [bookmark: pgfId-1472678]To map third-party fixes to Cisco fix definitions:
 
     [bookmark: pgfId-2100447]Access: Admin/
 
     
 
     [bookmark: pgfId-1921369]Step 1 Select Policies > Application Detectors, then click User Third-Party Mappings.
 
     [bookmark: pgfId-1427004]The User Third-Party Mappings page appears.
 
     [bookmark: pgfId-1427005]Step 2 You have two choices:
 
      
       
       	 [bookmark: pgfId-1427006]To edit an existing map set, click  Edit next to the map set.
 
       	 [bookmark: pgfId-1427007]To create a new map set, click  Create Product Map Set .
 
      
 
     
 
     [bookmark: pgfId-1427008]The Edit Third-Party Product Mappings page appears. 
 
     [bookmark: pgfId-1427013]Step 3 Type a name for the mapping set in the Mapping Set Name field.
 
     [bookmark: pgfId-1427014]Step 4 Type a description in the Description field.
 
     [bookmark: pgfId-1427015]Step 5 You have two choices:
 
      
       
       	 [bookmark: pgfId-1427016]To map a third-party product, click  Add Fix Map.  
 
       	 [bookmark: pgfId-1427017]To edit an existing third-party product map, click  Edit next to it. 
 
      
 
     
 
     [bookmark: pgfId-1427498]The Add Fix Map page appears.
 
     [bookmark: pgfId-1427018]Step 6 Type the name of the fix you want to map in the Third-Party Fix Name field.
 
     [bookmark: pgfId-1431595]Step 7 In [bookmark: marker-1431594]the Product Mappings section, select the operating system, product, and versions you want to use for fix mapping from the following lists (if applicable):
 
      
       
       	 [bookmark: pgfId-1431596] Vendor 
 
       	 [bookmark: pgfId-1431597] Product 
 
       	 [bookmark: pgfId-1431598] Major Version 
 
       	 [bookmark: pgfId-1431599] Minor Version 
 
       	 [bookmark: pgfId-1431600] Revision Version 
 
       	 [bookmark: pgfId-1431601] Build 
 
       	 [bookmark: pgfId-1431602] Patch 
 
       	 [bookmark: pgfId-1431603] Extension 
 
      
 
     
 
     [bookmark: pgfId-1431604]For example, if you want your mapping to assign the selected fixes from Red Hat Linux 9 to hosts where the patch is applied, select Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the version.
 
     [bookmark: pgfId-1427966]Step 8 Click Save to save the fix map. 
 
     [bookmark: pgfId-2093814]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1425403][bookmark: 95485]Mapp[bookmark: marker-1957888]ing Third-Party Vulnerabili[bookmark: marker-1443567]ties
 
     [bookmark: pgfId-1899009]License: FireSIGHT
 
     [bookmark: pgfId-1428678]To add vulnerability information from a third party to the VDB, you must map the third-party identification string for each imported vulnerability to any existing Cisco, Bugtraq, or Snort ID. After you create a mapping for the vulnerability, the mapping works for all vulnerabilities imported to hosts in your network map and allows impact correlation for those vulnerabilities. 
 
     [bookmark: pgfId-1433573]Note that you must also enable impact correlation for third-party vulnerabilities to allow correlation to occur. For more information, see Enabling Vulnerability Impact Assessment Mappings. For versionless or vendorless applications, you must also map vulnerabilities for the application types in the system policy. For more information, see Mapping Vulnerabilities for Servers.
 
     [bookmark: pgfId-1904128]Also, although many clients have associated vulnerabilities, and clients are used for impact assessment, you cannot use third-party client vulnerabilities for impact assessment.
 
      
       
     
 
     
 
     [bookmark: pgfId-1856658]Tip If you have already created a third-party mapping on another Defense Center, you can export it and then import it onto this Defense Center. You can then edit the imported mapping to suit your needs. For more information, see Importing and Exporting Configurations.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1428039]To map a third-party vulnerability to an existing vulnerability:
 
     [bookmark: pgfId-2100464]Access: Admin
 
     
 
     [bookmark: pgfId-1921393]Step 1 Select Policies > Application Detectors, then click User Third-Party Mappings.
 
     [bookmark: pgfId-1428044]The User Third-Party Mappings page appears.
 
     [bookmark: pgfId-1428106]Step 2 You have two choices:
 
      
       
       	 [bookmark: pgfId-1428107]To edit an existing vulnerability set, click  Edit next to the vulnerability set.
 
       	 [bookmark: pgfId-1428108]To create a new vulnerability set, click  Create Vulnerability Map Set .
 
      
 
     
 
     [bookmark: pgfId-1428182]The Edit Third-Party Vulnerability Mappings page appears. 
 
     [bookmark: pgfId-1428225]Step 3 Click Add Vulnerability Map.
 
     [bookmark: pgfId-1428238]The Add Vulnerability Map pop-up window appears. 
 
     [bookmark: pgfId-1428257]Step 4 Type the third-party identification for the vulnerability in the Vulnerability ID field. 
 
     [bookmark: pgfId-1428258]Step 5 Type a description in the Vulnerability Description field. 
 
     [bookmark: pgfId-1428259]Step 6 Optionally, enter a Signature ID in the Snort Vulnerability ID Mappings field.
 
     [bookmark: pgfId-1428290]Step 7 Optionally, enter an Cisco vulnerability ID in the Cisco Vulnerability ID Mappings field. 
 
     [bookmark: pgfId-1428250]Step 8 Optionally, enter a Bugtraq identification number in the Bugtraq Vulnerability ID Mappings field. 
 
     [bookmark: pgfId-1433358]Step 9 Click Add.
 
     [bookmark: pgfId-2093826]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1433360][bookmark: 93284]Managing Custom Product [bookmark: marker-1443583]Mappings
 
     [bookmark: pgfId-1899025]License: FireSIGHT
 
     [bookmark: pgfId-1433369]You can use product mappings to ensure that servers input by a third party are associated with the appropriate Cisco definitions. After you define and activate the product mapping, all servers or clients on hosts in your network map that have the mapped vendor strings use the custom product mappings. For this reason, you may want to map vulnerabilities for all servers in the network map with a particular vendor string instead of explicitly setting the vendor, product, and version for the server. 
 
     [bookmark: pgfId-1433373]For more information, see the following:
 
      
      	 [bookmark: pgfId-1433377]Creating Custom Product Mappings
 
      	 [bookmark: pgfId-1433381]Editing Custom Product Mapping Lists
 
      	 [bookmark: pgfId-1433385]Managing Custom Product Mapping Activation State
 
     
 
    
 
     
      [bookmark: pgfId-1433387][bookmark: 52378]Creating Custom Prod[bookmark: marker-1443584]uct Mappings
 
     [bookmark: pgfId-1899041]License: FireSIGHT
 
     [bookmark: pgfId-1904180]If the system cannot map a server in the network map to a vendor and product in the VDB, you can manually create the mapping for the system to use when identifying servers. When you activate a custom product mapping, the system maps vulnerabilities for the selected vendor and product to all servers in the network map where that vendor string occurs.
 
      
       
     
 
     
 
     [bookmark: pgfId-1444718]Note Custom product mappings apply to all occurrences of an application protocol, regardless of the source of the application data (such as Nmap, the host input feature, or the FireSIGHT System itself). However, if third-party vulnerability mappings for data imported using the host input feature conflicts with the mappings you set through a custom product mapping, the third-party vulnerability mapping overrides the custom product mapping and uses the third-party vulnerability mapping settings when the input occurs. For more information, see Mapping Third-Party Vulnerabilities.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1433405]You create lists of product mappings and then enable or disable use of several mappings at once by activating or deactivating each list. When you select a vendor to map to, the system updates the list of products to include only those made by that vendor. 
 
     [bookmark: pgfId-1433547]After you create a custom product mapping, you must activate the custom product mapping list. After you activate a list of custom product mappings, the system updates all servers with occurrences of the specified vendor strings. For data imported through the host input feature, vulnerabilities update unless you have already explicitly set the product mappings for this server. 
 
     [bookmark: pgfId-1448326]If, for example, your company modifies the banner for your Apache Tomcat web servers to read Internal Web Server, you can map the vendor string Internal Web Server to the vendor Apache and the product Tomcat, then activate the list containing that mapping, all hosts where a server labelled Internal Web Server occurs have the vulnerabilities for Apache Tomcat in the database.
 
      
       
     
 
     
 
     [bookmark: pgfId-1434703]Tip You can use this feature to map vulnerabilities to local intrusion rules by mapping the SID for the rule to another vulnerability. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1433412]To create a custom product mapping:
 
     [bookmark: pgfId-2100479]Access: Admin
 
     
 
     [bookmark: pgfId-1921440]Step 1 Select Policies > Application Detectors, and click Custom Product Mappings.
 
     [bookmark: pgfId-1433414]The Custom Product Mappings page appears.
 
     [bookmark: pgfId-1433419]Step 2 Click Create Custom Product Mapping List.
 
     [bookmark: pgfId-1433420]The Edit Custom Product Mappings List page appears. 
 
     [bookmark: pgfId-1433425]Step 3 Type a name in the Custom Product Mapping List Name field.
 
     [bookmark: pgfId-1433427]Step 4 [bookmark: 13345]Click Add Vendor String.
 
     [bookmark: pgfId-1433428]The Add Vendor String pop-up window appears.
 
     [bookmark: pgfId-1433433]Step 5 In the Vendor String field, type the vendor string that identifies the applications that should map to the selected vendor and product values.
 
     [bookmark: pgfId-1433440]Step 6 Select the vendor you want to map to from the Vendor drop-down list.
 
     [bookmark: pgfId-1433444]Step 7 Select the product you want to map to from the Product drop-down list.
 
     [bookmark: pgfId-1433446]Step 8 [bookmark: 53084]Click Add to add the mapped vendor string to the list. 
 
     [bookmark: pgfId-1433453]Step 9 Optionally, repeat steps 4 to 8 as needed to add additional vendor string mappings to the list. 
 
     [bookmark: pgfId-1433454]Step 10 When you finish, click Save.
 
     [bookmark: pgfId-1433455]The Custom Product Mappings page appears again, with the list you added.
 
     [bookmark: pgfId-2093853]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1433458][bookmark: 26192]Editing Custom Product Mapping Lists
 
     [bookmark: pgfId-1899058]License: FireSIGHT
 
     [bookmark: pgfId-1433467]You can modify existing custom product mapping lists by adding or removing vendor strings or changing the list name. 
 
     [bookmark: pgfId-1433468]To edit a custom product mapping:
 
     [bookmark: pgfId-2100500]Access: Admin
 
     
 
     [bookmark: pgfId-1921512]Step 1 Select Policies > Application Detectors, then click Custom Product Mappings.
 
     [bookmark: pgfId-1433470]The Custom Product Mappings page appears.
 ) next to the product mapping list to edit. 
     
 
     [bookmark: pgfId-1433476]The Edit Custom Product Mappings List page appears. 
 
     [bookmark: pgfId-1433481]Step 3 Make changes to the list as needed. For more information, see Creating Custom Product Mappings.
 
     [bookmark: pgfId-1433513]Step 4 [bookmark: 79128]When you finish, click Save.
 
     [bookmark: pgfId-1433514]The Custom Product Mappings page appears, with the list you updated.
 
     [bookmark: pgfId-2093865]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1433516][bookmark: 46027]Managing Custom Product Mapping Activation State
 
     [bookmark: pgfId-1899078]License: FireSIGHT
 
     [bookmark: pgfId-1433625]You can enable or disable use of an entire list of custom product mappings at once. After you activate a custom product mapping list, each mapping on that list applies to all applications on hosts in the network map with the specified vendor string, whether detected by managed devices or imported through the host input feature. 
 
     [bookmark: pgfId-1433518]To activate or deactivate a custom product mapping list:
 
     [bookmark: pgfId-2100521]Access: Admin
 
     
 
     [bookmark: pgfId-1921491]Step 1 Select Policies > Application Detectors, then click Custom Product Mappings.
 
     [bookmark: pgfId-1433520]The Custom Product Mappings page appears.
 
     [bookmark: pgfId-1433525]Step 2 Modify the state of custom product mapping lists:
 
      
       
       	 [bookmark: pgfId-1433526]To enable use of a custom product mapping list, click  Activate .
 
       	 [bookmark: pgfId-1433527]To disable use of a custom product mapping list, click  Deactivate .
 
      
 
     
 
     [bookmark: pgfId-2093877]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1424087] 
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2425954][bookmark: 21377]Configuri[bookmark: marker-2447684]ng Active Scanning 
      
      
 
     
 
 
    [bookmark: pgfId-2637286]The FireSIGHT System builds a network map through passive analysis of traffic on your network. However, you may sometimes need to actively scan a host to determine information about that host. For example, if a host has a server running on an open port but the server has not received or sent traffic during the time that the system has been monitoring your network, the system does not add information about that server to the network map. If you directly scan that host using an active scanner, however, you can detect the presence of the server. 
 
    [bookmark: pgfId-3355415]When you actively scan a host, you send packets in an attempt to obtain information about the host. The FireSIGHT System integrates with Nmap™ 6.01, an open source active scanner for network exploration and security auditing that can be used to detect operating systems and servers running on a host. With an Nmap scan, you can check for detailed information about the operating system and servers running on the host and refine the system’s vulnerability reporting based on those results.
 
     
      
    
 
    
 
    [bookmark: pgfId-2637367]Note Some scanning options (such as portscans) may place a significant load on networks with low bandwidths. You should always schedule scans like these to run during periods of low network use.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2679258]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-2679286]Understanding Nmap Scans
 
     	 [bookmark: pgfId-3403898]Setting up Nmap Scans
 
     	 [bookmark: pgfId-2679290]Managing Nmap Scanning
 
     	 [bookmark: pgfId-2679438]Managing Scan Targets
 
     	 [bookmark: pgfId-2679442]Working with Active Scan Results
 
    
 
   
 
    
     [bookmark: pgfId-2637242][bookmark: 66973]Understanding Nmap[bookmark: marker-2713355] Scans
 
    [bookmark: pgfId-3391076]License: FireSIGHT
 
    [bookmark: pgfId-3389185]Nmap allows you to actively scan ports on hosts on your network to determine operating system and server data for the hosts, which allows you to enhance your network map and fine-tune the accuracy of the vulnerabilities mapped to scanned hosts. Note that a host must exist in the network map before Nmap can append its results to the host profile. You can also view scan results in a results file.
 
    [bookmark: pgfId-3392046]When you scan a host using Nmap, servers on previously undetected open ports are added to the Servers list in the host profile for that host. The host profile lists any servers detected on filtered or closed TCP ports or on UDP ports in the Scan Results section. By default, Nmap scans more than 1660 TCP ports.
 
    [bookmark: pgfId-2702908]Nmap compares the results of the scan to over 1500 known operating system fingerprints to determine the operating system and assigns scores to each. The operating system assigned to the host is the operating system fingerprint with the highest score.
 
    [bookmark: pgfId-2645226]If the system recognizes a server identified in an Nmap scan and has a corresponding server definition, the system maps vulnerabilities for that server to the host. The system maps the names Nmap uses for servers to the corresponding Cisco server definitions, and then uses the vulnerabilities mapped to each server in the system. Similarly, the system maps Nmap operating system names to Cisco operating system definitions. When Nmap detects an operating system for a host, the system assigns vulnerabilities from the corresponding Cisco operating system definition to the host. 
 
    [bookmark: pgfId-3389267]For more information the underlying Nmap technology used to scan, refer to the Nmap documentation at http://insecure.org.
 
    [bookmark: pgfId-3389272]For more information on Nmap on your Cisco appliance, see the following topics:
 
     
     	 [bookmark: pgfId-3355434]Understanding Nmap Remediations
 
     	 [bookmark: pgfId-3142467]Creating an Nmap Scanning Strategy
 
     	 [bookmark: pgfId-3142515]Sample Nmap Scanning Profiles
 
    
 
     
      [bookmark: pgfId-3355440][bookmark: 92183]Understanding Nmap Remediations
 
     [bookmark: pgfId-3421443]License: FireSIGHT
 
     [bookmark: pgfId-3355441]You can define the settings for an Nmap scan by creating an Nmap remediation. An Nmap remediation can be used as a response in a correlation policy, run on demand, or scheduled to run at a specific time. In order for the results of an Nmap scan to appear in the network map, the scanned host must already exist in the network map.
 
     [bookmark: pgfId-3355445]Note that Nmap-supplied server and operating system data remain static until you run another Nmap scan. If you plan to scan a host for operating system and server data using Nmap, you may want to set up regularly scheduled scans to keep any Nmap-supplied operating system and server data up-to-date. For more information, see Automating Nmap Scans. Also note that if the host is deleted from the network map, any Nmap scan results for that host are discarded.
 
     [bookmark: pgfId-3355450]For more information about Nmap functionality, refer to the Nmap documentation at http://insecure.org. The following table explains the options configurable in Nmap remediations on a FireSIGHT System.
 
     [bookmark: pgfId-3355551]
 
      
       
        
        [bookmark: pgfId-3355459]Table 47-1 Nmap Remediation Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-3355463]Option 
          
  
         	 
           
           [bookmark: pgfId-3355465]Description 
          
  
         	 
           
           [bookmark: pgfId-3428921]Corresponding Nmap Option 
          
  
        
 
         
         	[bookmark: pgfId-3355467]Scan Which Address(es) From Event? 
  
         	[bookmark: pgfId-3355469]When you use an Nmap scan as a response to a correlation rule, select an option to control which address in the event is scanned, that of the source host, the destination host, or both.
  
         	[bookmark: pgfId-3428923]N/A
  
        
 
         
         	[bookmark: pgfId-3355471]Scan Types
  
         	[bookmark: pgfId-3355473]Select how Nmap scans ports: 
 
           
           	 [bookmark: pgfId-3355474]The  TCP Syn  scan connects quickly to thousand of ports without using a complete TCP handshake. This options allows you to scan quickly in stealth mode on hosts where the  admin account has raw packet access or where IPv6 is not running, by initiating TCP connections but not completing them. If a host acknowledges the Syn packet sent in a TCP Syn scan, Nmap resets the connection. 
 
           	 [bookmark: pgfId-3355475]The  TCP Connect scan uses the  connect() system call to open connections through the operating system on the host. You can use the TCP Connect scan if the  admin user on your Defense Center or managed device does not have raw packet privileges on a host or you are scanning IPv6 networks. In other words, use this option in situations where the TCP Syn scan cannot be used. 
 
           	 [bookmark: pgfId-3355482]The  TCP ACK scan sends an ACK packet to check whether ports are filtered or unfiltered.
 
           	 [bookmark: pgfId-3355483]The  TCP Window scan works in the same way as a TCP ACK scan but can also determine whether a port is open or closed.
 
           	 [bookmark: pgfId-3355484]The  TCP Maimon scan identifies BSD-derived systems using a FIN/ACK probe.
 
          
  
         	[bookmark: pgfId-3428925]TCP Syn: -sS
 [bookmark: pgfId-3429003]TCP Connect: -sT
 [bookmark: pgfId-3429022]TCP ACK: -sA
 [bookmark: pgfId-3429036]TCP Window: -sW
 [bookmark: pgfId-3429114]TCP Maimon: -sM
  
        
 
         
         	[bookmark: pgfId-3355486]Scan for UDP ports
  
         	[bookmark: pgfId-3355488]Enable to scan UDP ports in addition to TCP ports. Note that scanning UDP ports may be time-consuming, so avoid using this option if you want to scan quickly.
  
         	[bookmark: pgfId-3428927]-sU
  
        
 
         
         	[bookmark: pgfId-3355490]Use Port From Event 
  
         	[bookmark: pgfId-3355492]If you plan to use the remediation as a response in a correlation policy, enable to cause the remediation to scan only the port specified in the event that triggers the correlation response. 
 option to scan the port associated with the new server.  
         	[bookmark: pgfId-3428929]N/A
  
        
 
         
         	[bookmark: pgfId-3355495]Scan from reporting detection engine
  
         	[bookmark: pgfId-3355497]Enable to scan a host from the appliance where the detection engine that reported the host resides.
  
         	[bookmark: pgfId-3428931]N/A
  
        
 
         
         	[bookmark: pgfId-3355499]Fast Port Scan
  
         	[bookmark: pgfId-3355501]Enable to scan only the TCP ports listed in the nmap-services file located in the /var/sf/nmap/share/nmap/nmap-services directory on the device that does the scanning, ignoring other port settings. Note that you cannot use this option with the Port Ranges and Scan Order option.
  
         	[bookmark: pgfId-3428933]-F
  
        
 
         
         	[bookmark: pgfId-3355503]Port Ranges and Scan Order
  
         	[bookmark: pgfId-3355505]Set the specific ports you want to scan, using Nmap port specification syntax, and the order you want to scan them. Note that you cannot use this option with the Fast Port Scan option.
  
         	[bookmark: pgfId-3428935]-p
  
        
 
         
         	[bookmark: pgfId-3355507]Probe open ports for vendor and version information
  
         	[bookmark: pgfId-3355509]Enable to detect server vendor and version information. If you probe open ports for server vendor and version information, Nmap obtains server data that it uses to identify servers. It then replaces the Cisco server data for that server. 
  
         	[bookmark: pgfId-3428937]-sV
  
        
 
         
         	[bookmark: pgfId-3355514]Service Version Intensity 
  
         	[bookmark: pgfId-3355516]Select the intensity of Nmap probes for service versions. Higher service intensity numbers cause more probes to be used and result in higher accuracy, while lower intensity probes are faster but obtain less information.
  
         	[bookmark: pgfId-3428939]--version-intensity <intensity>
  
        
 
         
         	[bookmark: pgfId-3355518]Detect Operating System
  
         	[bookmark: pgfId-3355520]Enable to detect operating system information for the host. 
 [bookmark: pgfId-3355521]If you configure detection of the operating system for a host, Nmap scans the host and uses the results to create a rating for each operating system that reflects the likelihood that the operating system is running on the host. For more information on when and how Nmap-identified identity data appears in the network map, see Understanding Current Identities.
  
         	[bookmark: pgfId-3428941]-o
  
        
 
         
         	[bookmark: pgfId-3355526]Treat All Hosts As Online 
  
         	[bookmark: pgfId-3355528]Enable to skip the host discovery process and run a port scan on every host in the target range. Note that when you enable this option, Nmap ignores settings for Host Discovery Method and Host Discovery Port List.
  
         	[bookmark: pgfId-3428943]-PN
  
        
 
         
         	[bookmark: pgfId-3355530]Host Discovery Method 
  
         	[bookmark: pgfId-3355532]Select to perform host discovery for all hosts in the target range, over the ports listed in the Host Discovery Port List, or if no ports are listed, over the default ports for that host discovery method. 
 [bookmark: pgfId-3355533]Note that if you also enabled Treat All Hosts As Online, however, the Host Discovery Method option has no effect and host discovery is not performed. 
 [bookmark: pgfId-3355534]Select the method to be used when Nmap tests to see if a host is present and available:
 
           
           	 [bookmark: pgfId-3355535]The  TCP SYN option sends an empty TCP packet with the SYN flag set and recognizes the host as available if a response is received. TCP SYN scans port 80 by default. Note that TCP SYN scans are less likely to be blocked by a firewall with stateful firewall rules.
 
           	 [bookmark: pgfId-3355536]The  TCP ACK option sends an empty TCP packet with the ACK flag set and recognizes the host as available if a response is received. TCP ACK also scans port 80 by default. Note that TCP ACK scans are less likely to be blocked by a firewall with stateless firewall rules.
 
           	 [bookmark: pgfId-3355537]The  UDP option sends a UDP packet and assumes host availability if a port unreachable response comes back from a closed port. UDP scans port 40125 by default.
 
          
  
         	[bookmark: pgfId-3428945]TCP SYN: -PS
 [bookmark: pgfId-3429257]TCP ACK: -PA
 [bookmark: pgfId-3429271]UDP: -PU
  
        
 
         
         	[bookmark: pgfId-3355539]Host Discovery Port List 
  
         	[bookmark: pgfId-3355541]Specify a customized list of ports, separated by commas, that you want to scan when doing host discovery.
  
         	[bookmark: pgfId-3428947]port list for host discovery method
  
        
 
         
         	[bookmark: pgfId-3355543]Default NSE Scripts 
  
         	[bookmark: pgfId-3355545]Enable to run the default set of Nmap scripts for host discovery and server and operating system and vulnerability detection. See http://nmap.org/nsedoc/categories/default.html for the list of default scripts.
  
         	[bookmark: pgfId-3428949]-sC
  
        
 
         
         	[bookmark: pgfId-3355548]Timing Template
  
         	[bookmark: pgfId-3355550]Select the timing of the scan process; the higher the number you select, the faster and less comprehensive the scan. 
  
         	[bookmark: pgfId-3428951]0: T0 (paranoid)
 [bookmark: pgfId-3429360]1: T1 (sneaky)
 [bookmark: pgfId-3429377]2: T2 (polite)
 [bookmark: pgfId-3429398]3: T3 (normal)
 [bookmark: pgfId-3429418]4: T4 (aggressive)
 [bookmark: pgfId-3429442]5: T5 (insane)
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2632416][bookmark: 28814]Creating an Nmap Scanning Strategy
 
     [bookmark: pgfId-3391092]License: FireSIGHT
 
     [bookmark: pgfId-2647632]While active scanning can obtain valuable information, overuse of a tool such as Nmap may overload your network resources or even crash important hosts. When using any active scanner, you should create a scanning strategy to make sure that you are scanning only the hosts and ports that you need to scan.
 
     [bookmark: pgfId-2702915]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-2702916]Selecting Appropriate Scan Targets
 
      	 [bookmark: pgfId-2702920]Selecting Appropriate Ports to Scan
 
      	 [bookmark: pgfId-3355559]Setting Host Discovery Options
 
     
 
    
 
     
      [bookmark: pgfId-2632417][bookmark: 79967]Selecting Appropriate Scan Targets
 
     [bookmark: pgfId-3390414]License: FireSIGHT
 
     [bookmark: pgfId-3246629]When you configure Nmap, you can create scan targets that identify which hosts you want to scan. A scan target includes a single IP address, a CIDR block or octet range of IP addresses, an IP address range, or a list of IP addresses or ranges to scan, as well as the ports on the host or hosts. 
 
     [bookmark: pgfId-3246626]You can specify targets in the following ways:
 
      
      	 [bookmark: pgfId-2646474]For IPv6 hosts:
 
     
 
     [bookmark: pgfId-3431284] – an exact IP address (for example, 192.168.1.101)
 
      
      	 [bookmark: pgfId-3431178]For IPv4 hosts:
 
     
 
     [bookmark: pgfId-3431271] – an exact IP address (for example, 192.168.1.101) or a list of IP addresses separated by commas or spaces
 
     [bookmark: pgfId-3008087] – an IP address block using CIDR notation (for example, 192.168.1.0/24 scans the 254 hosts between 192.168.1.1 and 192.168.1.254, inclusive)
 
     [bookmark: pgfId-3059090]For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-2646476] – an IP address range using octet range addressing (for example, 192.168.0-255.1-254 scans all addresses in the 192.168.x.x range, except those that end in .0 and or .255)
 
     [bookmark: pgfId-3355574] – an IP address range using hyphenation (for example, 192.168.1.1 - 192.168.1.5 scans the six hosts between 192.168.1.1 and 192.168.1.5, inclusive)
 
     [bookmark: pgfId-3355575] – a list of addresses or ranges separated by commas or spaces (for example, for example, 192.168.1.0/24, 194.168.1.0/24 scans the 254 hosts between 192.168.1.1 and 192.168.1.254, inclusive and the 254 hosts between 194.168.1.1 and 194.168.1.254, inclusive)
 
     [bookmark: pgfId-3392074]Ideal scan targets for Nmap scans include hosts with operating systems that the system is unable to identify, hosts with unidentified servers, or hosts recently detected on your network. Remember that Nmap results cannot be added to the network map for hosts that do not exist in the network map.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2646706] 
      Caution Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, you may want to set up regularly scheduled scans to keep any Nmap-supplied operating system and server data up to date. For more information, see 
      Automating Nmap Scans. Also note that if the host is deleted from the network map, any Nmap scan results are discarded. In addition, make sure you have permission to scan your targets. Using Nmap to scan hosts that do not belong to you or your company may be illegal. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-2646178][bookmark: 81429]Selecting Appropriate Ports to Scan
 
     [bookmark: pgfId-3390430]License: FireSIGHT
 
     [bookmark: pgfId-2646179]For each scan target you configure, you can select the ports you want to scan. You can designate individual port numbers, port ranges, or a series of port numbers and port ranges to identify the exact set of ports that should be scanned on each target.
 
     [bookmark: pgfId-2646812]By default, Nmap scans TCP ports 1 through 1024. If you plan to use the remediation as a response in a correlation policy, you can cause the remediation to scan only the port specified in the event that triggers the correlation response. If you run the remediation on demand or as a scheduled task, or if you do not use the port from the event, you can use other port options to determine which ports are scanned. You can choose to scan only the TCP ports listed in the nmap-services file, ignoring other port settings. You can also scan UDP ports in addition to TCP ports. Note that scanning for UDP ports may be time-consuming, so avoid using that option if you want to scan quickly. To select the specific ports or range of ports to scan, use Nmap port specification syntax to identify ports. 
 
    
 
     
      [bookmark: pgfId-3355586][bookmark: 25525]Setting Host Discovery Options
 
     [bookmark: pgfId-3398404]License: FireSIGHT
 
     [bookmark: pgfId-3355587]You can decide whether to perform host discovery before starting a port scan for a host, or you can assume that all the hosts you plan to scan are online. If you choose not to treat all hosts as online, you can choose what method of host discovery to use and, if needed, customize the list of ports scanned during host discovery. Host discovery does not probe the ports listed for operating system or server information; it uses the response over a particular port only to determine whether a host is active and available. If you perform host discovery and a host is not available, Nmap does not scan ports on that host.
 
    
 
     
      [bookmark: pgfId-2632419][bookmark: 18594]Sample Nmap Scanning[bookmark: marker-2713356] Profiles
 
     [bookmark: pgfId-3390446]License: FireSIGHT
 
     [bookmark: pgfId-2651655]The following scenarios provide examples of how Nmap might be used on your network:
 
      
      	 [bookmark: pgfId-2651686]Example: Resolving Unknown Operating Systems
 
      	 [bookmark: pgfId-2651699]Example: Responding to New Hosts
 
     
 
    
 
     
      [bookmark: pgfId-2634980][bookmark: 32642]Example: Resolving Unknown Operating Systems
 
     [bookmark: pgfId-3390462]License: FireSIGHT
 
     [bookmark: pgfId-2647687]If the system cannot determine the operating system on a host on your network, you can use Nmap to actively scan the host. Nmap uses the information it obtains from the scan to rate the possible operating systems. It then uses the operating system that has the highest rating as the host operating system identification. 
 
     [bookmark: pgfId-2650188]Using Nmap to challenge new hosts for operating system and server information deactivates the system’s monitoring of that data for scanned hosts. If you use Nmap to discover host and server operating system for hosts the system marks as having unknown operating systems, you may be able to identify groups of hosts that are similar. You can then create a custom fingerprint based on one of them to cause the system to associate the fingerprint with the operating system you know is running on the host based on the Nmap scan. Whenever possible, create a custom fingerprint rather than inputting static data through a third-party source like Nmap because the custom fingerprint allows the system to continue to monitor the host operating system and update it as needed. 
 
     [bookmark: pgfId-2650192]To discover operating systems with Nmap:
 
     [bookmark: pgfId-2743443]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2650193]Step 1 Configure a scan instance for an Nmap module. 
 
     [bookmark: pgfId-3355595]For more information, see Creating an Nmap Scan Instance.
 
     [bookmark: pgfId-2651722]Step 2 [bookmark: 72485]Create an Nmap remediation using the following settings:
 
      
       
       	 [bookmark: pgfId-2651723]Enable  Use Port From Event to scan the port associated with the new server.
 
       	 [bookmark: pgfId-2651724]Enable  Detect Operating System  to detect operating system information for the host.
 
       	 [bookmark: pgfId-2651725]Enable  Probe open ports for vendor and version information to detect server vendor and version information.
 
       	 [bookmark: pgfId-3355600]Enable  Treat All Hosts as Online , because you know the host exists.
 
      
 
     
 
     [bookmark: pgfId-3355607]For information on creating Nmap remediations, see Creating an Nmap Remediation.
 
     [bookmark: pgfId-2651740]Step 3 [bookmark: 12953]Create a correlation rule that triggers when the system detects a host with an unknown operating system.
 
     [bookmark: pgfId-2651744]The rule should trigger when an discovery event occurs and the OS information for a host has changed and it meets the following conditions: OS Name is unknown.
 
     [bookmark: pgfId-2651747]For information on creating correlation rules, see Creating Rules for Correlation Policies.
 
     [bookmark: pgfId-2651749]Step 4 Create a correlation policy that contains the correlation rule.
 
     [bookmark: pgfId-2651752]For more information on creating correlation policies, see Creating Correlation Policies.
 
     [bookmark: pgfId-2651757]Step 5 In the correlation policy, add the Nmap remediation you created in step 2 as a response to the rule you created in step 3.
 
     [bookmark: pgfId-2651764]Step 6 Activate the correlation policy.
 
     [bookmark: pgfId-2651653]Step 7 Purge the hosts on your network map to force network discovery to restart and rebuild the network map.
 
     [bookmark: pgfId-2651952]Step 8 After a day or two, search for events generated by the correlation policy. Analyze the Nmap results for the operating systems detected on the hosts to see if there is a particular host configuration on your network that the system does not recognize. 
 
     [bookmark: pgfId-2651956]For more information on analyzing Nmap results, see Analyzing Scan Results.
 
     [bookmark: pgfId-2721718]Step 9 If you find hosts with unknown operating systems whose Nmap results are identical, create a custom fingerprint for one of those hosts and use it to identify similar hosts in the future. 
 
     [bookmark: pgfId-2721722]For more information, see Fingerprinting Clients.
 
     [bookmark: pgfId-3455401]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2721724][bookmark: 11021]Example: Responding to New Hosts
 
     [bookmark: pgfId-3390478]License: FireSIGHT
 
     [bookmark: pgfId-2648107]When the system detects a new host in a subnet where intrusions may be likely, you may want to scan that host to make sure you have accurate vulnerability information for it.
 
     [bookmark: pgfId-2648111]You can accomplish this by creating and activating a correlation policy that detects when a new host appears in this subnet, and that launches a remediation that performs an Nmap scan on the host.
 
     [bookmark: pgfId-2648112]After you activate the policy, you can periodically check the remediation status view (Policy & Response > Responses > Remediations > Status) to see when the remediation launched. The remediation’s dynamic scan target should include the IP addresses of the hosts it scanned as a result of the server detection. Check the host profile for those hosts to see if there are vulnerabilities that need to be addressed for the host, based on the operating system and servers detected by Nmap.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2648113] 
      Caution If you have a large or dynamic network, detection of a new host may be too frequent an occurrence to respond to using a scan. To prevent resource overload, avoid using Nmap scans as a response to events that occur frequently. In addition, note that using Nmap to challenge new hosts for operating system and server information deactivates Cisco monitoring of that data for scanned hosts. 
       
       
 
      
 
     
 
     [bookmark: pgfId-2648114]To scan in response to the appearance of a new host:
 
     [bookmark: pgfId-2743451]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2648123]Step 1 Configure a scan instance for an Nmap module. 
 
     [bookmark: pgfId-3355616]For more information, see Creating an Nmap Scan Instance.
 
     [bookmark: pgfId-2648135]Step 2 [bookmark: 13279]Create an Nmap remediation using the following settings:
 
      
       
       	 [bookmark: pgfId-2648136]Enable  Use Port From Event to scan the port associated with the new server.
 
       	 [bookmark: pgfId-2649859]Enable  Detect Operating System  to detect operating system information for the host.
 
       	 [bookmark: pgfId-2649860]Enable  Probe open ports for vendor and version information to detect server vendor and version information.
 
       	 [bookmark: pgfId-3355621]Enable  Treat All Hosts as Online , because you know the host exists.
 
      
 
     
 
     [bookmark: pgfId-3355624]For information on creating Nmap remediations, see Creating an Nmap Remediation.
 
     [bookmark: pgfId-2648149]Step 3 [bookmark: 12164][bookmark: 68059]Create a correlation rule that triggers when the system detects a new host on a specific subnet.
 
     [bookmark: pgfId-2648150]The rule should trigger when a discovery event occurs and a new host is detected.
 
     [bookmark: pgfId-2648165]For information on creating correlation rules, see Creating Rules for Correlation Policies.
 
     [bookmark: pgfId-2648167]Step 4 Create a correlation policy that contains the correlation rule.
 
     [bookmark: pgfId-2648170]For more information on creating correlation policies, see Creating Correlation Policies.
 
     [bookmark: pgfId-2648175]Step 5 In the correlation policy, add the Nmap remediation you created in step 2 as a response to the rule you created in step 3.
 
     [bookmark: pgfId-2648179]Step 6 Activate the correlation policy.
 
     [bookmark: pgfId-2649979]Step 7 When you are notified of a new host, check the host profile to see the results of the Nmap scan and address any vulnerabilities that apply to the host.
 
     [bookmark: pgfId-3455425]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2632797][bookmark: 42867]Setting up Nmap [bookmark: marker-2712157]Scans
 
    [bookmark: pgfId-3390496]License: FireSIGHT
 
    [bookmark: pgfId-2644583]To scan using Nmap, you must first configure a scan instance and a scan remediation. If you plan to schedule Nmap scans, you must also define a scan target. 
 
    [bookmark: pgfId-2658314]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3355641]Creating an Nmap Scan Instance
 
     	 [bookmark: pgfId-2644623]Creating an Nmap Scan Target
 
     	 [bookmark: pgfId-3355649]Creating an Nmap Remediation
 
    
 
     
      [bookmark: pgfId-3355672][bookmark: 66577]Creating an Nmap Scan[bookmark: marker-3355671] Instance
 
     [bookmark: pgfId-3390531]License: FireSIGHT
 
     [bookmark: pgfId-3355681]You can set up a separate scan instance for each Nmap module that you want to use to scan your network for vulnerabilities. You can set up scan instances for the local Nmap module on your Defense Center and for any devices you want to use to run scans remotely. The results of each scan are always stored on the Defense Center where you configure the scan, even if you run the scan from a remote device. To prevent accidental or malicious scanning of mission-critical hosts, you can create a blacklist for the instance to indicate the hosts that should never be scanned with the instance.
 
     [bookmark: pgfId-3355688]Note that you cannot add a scan instance with the same name as any existing scan instance.
 
     [bookmark: pgfId-3355689]To create a scan instance:
 
     [bookmark: pgfId-3392526]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-3392527]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-3392528]The Scanners page appears.
 
     [bookmark: pgfId-3355693]Step 2 Click Add Nmap Instance.
 
     [bookmark: pgfId-3355694]The Instance Detail page appears.
 
     [bookmark: pgfId-3355699]Step 3 In the Instance Name field, enter a name that includes 1 to 63 alphanumeric characters, with no spaces and no special characters other than underscore (_) and dash (-). 
 
     [bookmark: pgfId-3355700]Step 4 In the Description field, specify a description with 0 to 255 alphanumeric characters, which can include spaces and special characters.
 
     [bookmark: pgfId-3355701]Step 5 Optionally, in the Black Listed Scan hosts field, specify any hosts or networks that should never be scanned with this scan instance, using the following syntax:
 
      
       
       	 [bookmark: pgfId-3431630]For IPv6 hosts, an exact IP address (for example,  2001:DB8::fedd:eeff )
 
       	 [bookmark: pgfId-3431293]For IPv4 hosts, an exact IP address (for example,  192.168.1.101 ) or an IP address block using CIDR notation (for example,  192.168.1.0/24 scans the 254 hosts between  192.168.1.1 and  192.168.1.254 , inclusive)
 
       	 [bookmark: pgfId-3433617]Note that you cannot use an exclamation mark (!) to negate an address value.
 
      
 
     
 
     [bookmark: pgfId-3355715]If you specifically target a scan to a host that is in a blacklisted network, that scan will not run.
 
     [bookmark: pgfId-3355719]Step 6 Optionally, to run the scan from a remote device instead of the Defense Center, specify the IP address or name of the device as it appears in the Information page for the device in the Defense Center web interface, in the Remote Device Name field.
 
     [bookmark: pgfId-3355723]Step 7 Click Create.
 
     [bookmark: pgfId-3355724]The scan instance is created. 
 
     [bookmark: pgfId-3455469]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3108273][bookmark: 99389]Creating an Nmap Scan [bookmark: marker-3108248]Target
 
     [bookmark: pgfId-3390548]License: FireSIGHT
 
     [bookmark: pgfId-2632839]You can create and save scan targets that identify specific hosts and ports. Then, when you perform an on-demand scan or schedule a scan, you can use one of the saved scan targets. 
 
     [bookmark: pgfId-3430646]For scans of targets with IPv4 addresses, you can use an IP address, a list of IP addresses, CIDR notation, or Nmap scan octets to select the hosts to scan. You can also specify a range of addresses using a hyphen. Separate addresses and ranges in a list with commas or spaces. 
 
     [bookmark: pgfId-3430697]For scans of IPv6 addresses, use an IP address. Ranges are not supported. 
 
     [bookmark: pgfId-3431753]Note that Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, you may want to set up regularly scheduled scans to keep any Nmap-supplied operating system and server data up to date. For more information, see Automating Nmap Scans. Also note that if the host is deleted from the network map, any Nmap scan results for that host are discarded.
 
     [bookmark: pgfId-2632840]To create a scan target:
 
     [bookmark: pgfId-3392231]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2632841]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-2632842]The Scanners page appears.
 
     [bookmark: pgfId-2632843]Step 2 On the toolbar, click Targets. 
 
     [bookmark: pgfId-2654170]The Scan Target List page appears.
 
     [bookmark: pgfId-2654172]Step 3 Click Create Scan Target.
 
     [bookmark: pgfId-2632850]The Scan Target page appears.
 
     [bookmark: pgfId-2632855]Step 4 In the Name field, type the name you want to use for this scan target.
 
     [bookmark: pgfId-3351775]Step 5 In the IP Range text box, specify the host or hosts you want to scan, using the following syntax:
 
      
       
       	 [bookmark: pgfId-3351780]for IPv6 hosts, an exact IP address (for example,  2001:DB8::fedd:eeff ) 
 
       	 [bookmark: pgfId-3431117]for IPv4 hosts, an exact IP address (for example,  192.168.1.101 ) or comma-separated list of IP addresses 
 
       	 [bookmark: pgfId-3351782]for IPv4 hosts, an IP address block using CIDR notation (for example,  192.168.1.0/24 scans the 254 hosts between 192.168.1.1 and 192.168.1.254, inclusive)
 
      
 
     
 
     [bookmark: pgfId-3136900]For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
      
       
       	 [bookmark: pgfId-3423599]for IPv4 hosts, an IP address range using octet range addressing (for example,  192.168.0-255.1-254 scans all addresses in the  192.168.x.x range, except those that end in .0 and or .255)
 
       	 [bookmark: pgfId-3423600]for IPv4 hosts, an IP address range using hyphenation (for example,  192.168.1.1 -  192.168.1.5 scans the 6 hosts between 192.168.1.1 and 192.168.1.5, inclusive)
 
       	 [bookmark: pgfId-3355756]for IPv4 hosts, a list of addresses or ranges separated by commas or spaces (for example, for example,  192.168.1.0/24, 194.168.1.0/24 scans the 254 hosts between 192.168.1.1 and 192.168.1.254, inclusive and the 254 hosts between 194.168.1.1 and 194.168.1.254, inclusive)
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3136905]Note The IP Range text box accepts up to 255 characters. In addition, note that if you use a comma in a list of IP addresses or ranges in a scan target, the comma converts to a space when you save the target.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3136906]Step 6 In the Ports field, specify the ports you want to scan.
 
     [bookmark: pgfId-2632862]You can enter any of the following, using values from 1 to 65535:
 
      
       
       	 [bookmark: pgfId-2703026]a port number 
 
       	 [bookmark: pgfId-2703029]a list of ports separated by commas 
 
       	 [bookmark: pgfId-2703030]a range of port numbers separated by a dash
 
       	 [bookmark: pgfId-3369980]ranges of port numbers separated by dashes, separated by commas
 
      
 
     
 
     [bookmark: pgfId-3369982]Step 7 Click Save.
 
     [bookmark: pgfId-3369983]The scan target is created.
 
     [bookmark: pgfId-3455483]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3355779][bookmark: 24807]Creating an Nmap [bookmark: marker-3355778]Remediation
 
     [bookmark: pgfId-3390569]License: FireSIGHT
 
     [bookmark: pgfId-3355788]You can define the settings for an Nmap scan by creating an Nmap remediation. An Nmap remediation can be used as a response in a correlation policy, run on demand, or scheduled to run at a specific time. In order for the results of an Nmap scan to appear in the network map, the scanned host must already exist in the network map.
 
     [bookmark: pgfId-3355794]For more information on the specific settings in an Nmap remediation, see Understanding Nmap Remediations.
 
     [bookmark: pgfId-3355796]Note that Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host for operating system and server data using Nmap, you may want to set up regularly scheduled scans to keep any Nmap-supplied operating system and server data up-to-date. For more information, see Automating Nmap Scans. Also note that if the host is deleted from the network map, any Nmap scan results for that host are discarded.
 
     [bookmark: pgfId-3355801]For general information about Nmap functionality, refer to the Nmap documentation at http://insecure.org.
 
     [bookmark: pgfId-3355802]To create an Nmap remediation:
 
     [bookmark: pgfId-3392245]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-3355804]Step 1 Select Policies > Actions > Scanners.
 
     [bookmark: pgfId-3355805]The Scanners page appears.
 
     [bookmark: pgfId-3355810]Step 2 Click Add Remediation next to the scan instance where you want to add a remediation.
 
     [bookmark: pgfId-3355811]The Edit Remediation page appears.
 
     [bookmark: pgfId-3355816]Step 3 In the Remediation Name field, type a name for the remediation that includes 1 to 63 alphanumeric characters, with no spaces and no special characters other than underscore (_) and dash (-).
 
     [bookmark: pgfId-3355817]Step 4 In the Description field, type a description for the remediation that includes 0 to 255 alphanumeric characters, including spaces and special characters.
 
     [bookmark: pgfId-3355819]Step 5 [bookmark: 57153]If you plan to use this remediation in response to a correlation rule that triggers on an intrusion event, a connection event, or a user event, configure the Scan Which Address(es) From Event? option:
 
      
       
       	 [bookmark: pgfId-3355823]Select  Scan Source and Destination Addresses to scan the hosts represented by the source IP address and the destination IP address in the event.
 
       	 [bookmark: pgfId-3355824]Select  Scan Source Address Only to scan the host represented by the event’s source IP address.
 
       	 [bookmark: pgfId-3355825]Select  Scan Destination Address Only to scan the host represented by the event’s destination IP address.
 
      
 
     
 
     [bookmark: pgfId-3355829]If you plan to use this remediation in response to a correlation rule that triggers on a discovery event or a host input event, by default the remediation scans the IP address of the host involved in the event; you do not need to configure this option.
 
      
       
     
 
     
 
     [bookmark: pgfId-3355830]Note Do not assign an Nmap remediation as a response to a correlation rule that triggers on a traffic profile change.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3355832]Step 6 [bookmark: 65128]Configure the Scan Type option:
 
      
       
       	 [bookmark: pgfId-3355833]To scan quickly in stealth mode on hosts where the  admin account has raw packet access or where IPv6 is not running, by initiating TCP connections but not completing them, select  TCP Syn Scan . 
 
       	 [bookmark: pgfId-3355834]To scan by using a system  connect() call, which can be used on hosts where the  admin account on your Defense Center does not have raw packet access or where IPv6 is running, select  TCP Connect Scan .
 
       	 [bookmark: pgfId-3355838]To send an ACK packet to check whether ports are filtered or unfiltered, select  TCP ACK Scan .
 
       	 [bookmark: pgfId-3355839]To send an ACK packet to check whether ports are filtered or unfiltered but also to determine whether a port is open or closed, select  TCP Window Scan .
 
       	 [bookmark: pgfId-3355840]To identify BSD-derived systems using a FIN/ACK probe, select  TCP Maimon Scan .
 
      
 
     
 
     [bookmark: pgfId-3355841]Step 7 Optionally, to scan UDP ports in addition to TCP ports, select On for the Scan for UDP ports option.
 
      
       
     
 
     
 
     [bookmark: pgfId-3355842]Tip A UDP portscan takes more time than a TCP portscan. To speed up your scans, leave this option disabled.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3355844]Step 8 [bookmark: 80649]If you plan to use this remediation in response to correlation policy violations, configure the Use Port From Event option:
 
      
       
       	 [bookmark: pgfId-3355845]Select  On to scan the port in the correlation event, rather than the ports you specify in step  11 .
 
      
 
     
 
     [bookmark: pgfId-3355849]If you scan the port in the correlation event, note that the remediation scans the port on the IP addresses that you specified in step 5. These ports are also added to the remediation’s dynamic scan target.
 
      
       
       	 [bookmark: pgfId-3355856]Select  Off to scan only the ports you will specify in step  11 .
 
      
 
     
 
     [bookmark: pgfId-3355857]Step 9 If you plan to use this remediation in response to correlation policy violations and want to run the scan using the appliance running the detection engine that detected the event, configure the Scan from reporting detection engine option:
 
      
       
       	 [bookmark: pgfId-3355858]To scan from the appliance running the reporting detection engine, select  On . 
 
       	 [bookmark: pgfId-3355859]To scan from the appliance configured in the remediation, select  Off . 
 
      
 
     
 
     [bookmark: pgfId-3355860]Step 10 Configure the Fast Port Scan option:
 
      
       
       	 [bookmark: pgfId-3355861]To scan only the ports listed in the  nmap-services file located in the  /var/sf/nmap/share/nmap/nmap-services directory on the device that does the scanning, ignoring other port settings, select  On . 
 
       	 [bookmark: pgfId-3355862]To scan all TCP ports, select  Off . 
 
      
 
     
 
     [bookmark: pgfId-3355864]Step 11 [bookmark: 84923]In the Port Ranges and Scan Order field, type the ports you want to scan by default, using Nmap syntax, in the order you want to scan those ports. 
 
     [bookmark: pgfId-3355865]Specify values from 1 to 65535. Separate ports using commas or spaces. You can also use a hyphen to indicate a port range. When scanning for both TCP and UDP ports, preface the list of TCP ports you want to scan with a T and the list of UDP ports with a U. For example, to scan ports 53 and 111 for UDP traffic, then scan ports 21-25 for TCP traffic, enter U:53,111,T:21-25.
 
     [bookmark: pgfId-3355866]Note that the Use Port From Event option overrides this setting when the remediation is launched in response to a correlation policy violation, as described in step 8. 
 
     [bookmark: pgfId-3355870]Step 12 To probe open ports for server vendor and version information, configure Probe open ports for vendor and version information:
 
      
       
       	 [bookmark: pgfId-3355871]Select  On to scan open ports on the host for server information to identify server vendors and versions.
 
       	 [bookmark: pgfId-3355875]Select  Off to continue using Cisco server information for the host.
 
      
 
     
 
     [bookmark: pgfId-3392106]Step 13 If you choose to probe open ports, set the number of probes used by selecting a number from the Service Version Intensity drop-down list:
 
      
       
       	 [bookmark: pgfId-3392107]To use more probes for higher accuracy with a longer scan, select a higher number.
 
       	 [bookmark: pgfId-3355878]To use fewer probes for less accuracy with a faster scan, select a lower number. 
 
      
 
     
 
     [bookmark: pgfId-3355879]Step 14 To scan for operating system information, configure Detect Operating System settings:
 
      
       
       	 [bookmark: pgfId-3355880]Select  On to scan the host for information to identify the operating system.
 
       	 [bookmark: pgfId-3355884]Select  Off to continue using Cisco operating system information for the host.
 
      
 
     
 
     [bookmark: pgfId-3355885]Step 15 To determine whether host discovery occurs and whether port scans are only run against available hosts, configure Treat All Hosts As Online:
 
      
       
       	 [bookmark: pgfId-3355886]To skip the host discovery process and run a port scan on every host in the target range, select  On . 
 
       	 [bookmark: pgfId-3355887]To perform host discovery using the settings for  Host Discovery Method and  Host Discovery Port List and skip the port scan on any host that is not available, select  Off .
 
      
 
     
 
     [bookmark: pgfId-3355888]Step 16 Select the method you want Nmap to use when it tests for host availability:
 
      
       
       	 [bookmark: pgfId-3355889]To send an empty TCP packet with the SYN flag set and elicit an RST response on a closed port or a SYN/ACK response on an open port on available hosts, select  TCP SYN . 
 
      
 
     
 
     [bookmark: pgfId-3355890]Note that this option scans port 80 by default and that TCP SYN scans are less likely to be blocked by a firewall with stateful firewall rules.
 
      
       
       	 [bookmark: pgfId-3355891]To send an empty TCP packet with the ACK flag set and elicit an RST response on available hosts, select  TCP ACK.  
 
      
 
     
 
     [bookmark: pgfId-3355892]Note that this option scans port 80 by default and that TCP ACK scans are less likely to be blocked by a firewall with stateless firewall rules.
 
      
       
       	 [bookmark: pgfId-3355893]To send a UDP packet to elicit port unreachable responses from closed ports on available hosts, select  UDP . This option scans port 40125 by default.
 
      
 
     
 
     [bookmark: pgfId-3355894]Step 17 If you want to scan a custom list of ports during host discovery, type a list of ports appropriate for the host discovery method you selected, separated by commas, in the Host Discovery Port List field.
 
     [bookmark: pgfId-3355895]Step 18 Configure the Default NSE Scripts option to control whether to use the default set of Nmap scripts for host discovery and server, operating system, and vulnerability discovery:
 
      
       
       	 [bookmark: pgfId-3355896]To run the default set of Nmap scripts, select  On .
 
       	 [bookmark: pgfId-3397781]To skip the default set of Nmap scripts, select  Off .
 
      
 
     
 
     [bookmark: pgfId-3397783]See http://nmap.org/nsedoc/categories/default.html for the list of default scripts.
 
     [bookmark: pgfId-3355900]Step 19 To set the timing of the scan process, select a timing template number; select a higher number for a faster, less comprehensive scan and a lower number for a slower, more comprehensive scan. 
 
     [bookmark: pgfId-3355901]Step 20 Click Save, then click Done.
 
     [bookmark: pgfId-3355902]The remediation is created.
 
     [bookmark: pgfId-3455489]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3107346][bookmark: 18266]Managing Nmap[bookmark: marker-2713360] Scanning
 
    [bookmark: pgfId-3390590]License: FireSIGHT
 
    [bookmark: pgfId-2644411]You can modify or delete Nmap scan instances and remediations as needed. You can also run an on-demand Nmap scan. You can also view or download Nmap results for previous scans. For more information, see the following sections:
 
     
     	 [bookmark: pgfId-2644417]Managing Nmap Scan Instances
 
     	 [bookmark: pgfId-2644425]Managing Nmap Remediations
 
     	 [bookmark: pgfId-3355910]Running an On-Demand Nmap Scan
 
    
 
     
      [bookmark: pgfId-2632965][bookmark: 91356]Managing Nmap Scan[bookmark: marker-2713361] Instances
 
     [bookmark: pgfId-3390610]License: FireSIGHT
 
     [bookmark: pgfId-2638788]You can edit or delete Nmap scan instances. For more information, see the following sections:
 
      
      	 [bookmark: pgfId-2703100]Editing an Nmap Scan Instance
 
      	 [bookmark: pgfId-2703112]Deleting an Nmap Scan Instance
 
     
 
    
 
     
      [bookmark: pgfId-2632967][bookmark: 40920]Editing an Nmap Scan Instance
 
     [bookmark: pgfId-3390630]License: FireSIGHT
 
     [bookmark: pgfId-2637934]Use the following procedure to modify scan instances. Note that you can view, add, and delete remediations associated with the instance when you modify it.
 
     [bookmark: pgfId-2637942]To edit a scan instance:
 
     [bookmark: pgfId-3392266]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2637943]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-2637944]The Scanners page appears.
 
     [bookmark: pgfId-2637945]Step 2 Click View next to the instance you want to edit.
 
     [bookmark: pgfId-2637946]The Instance Detail page appears.
 
     [bookmark: pgfId-2637951]Step 3 Optionally, click View next to the remediation you want to view or edit. 
 
     [bookmark: pgfId-2637954]For more information on editing remediations, see Editing an Nmap Remediation.
 
     [bookmark: pgfId-2637956]Step 4 Optionally, click Delete next to the remediation you want to delete. 
 
     [bookmark: pgfId-2637959]For more information on deleting remediations, see Deleting an Nmap Remediation.
 
     [bookmark: pgfId-2637961]Step 5 Optionally, click Add to add a new remediation to this scan instance.
 
     [bookmark: pgfId-2637964]For more information on creating new remediations, see Managing Nmap Remediations.
 
     [bookmark: pgfId-2637966]Step 6 Optionally, make changes to the scan instance settings, then click Save.
 
     [bookmark: pgfId-2637967]Step 7 Click Done.
 
     [bookmark: pgfId-2637968]The scan instance is modified.
 
     [bookmark: pgfId-3455498]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2632969][bookmark: 28735]Deleting an Nmap Scan Instance
 
     [bookmark: pgfId-3390651]License: FireSIGHT
 
     [bookmark: pgfId-2638143]Delete an Nmap scan instance when you no longer want to use the Nmap module profiled in the instance. Note that when you delete the scan instance, you also delete any remediations that use that instance.
 
     [bookmark: pgfId-2638144]To delete a scan instance:
 
     [bookmark: pgfId-3392283]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2638145]Step 1 Click Policies > Actions > Scanners. 
 
     [bookmark: pgfId-2638146]The Scanners page appears.
 
     [bookmark: pgfId-2638147]Step 2 Click Delete next to the scan instance you want to delete.
 
     [bookmark: pgfId-2638148]The instance is deleted.
 
     [bookmark: pgfId-3455534]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2632970][bookmark: 76030]Managing Nmap [bookmark: marker-2713362]Remediations
 
     [bookmark: pgfId-3390668]License: FireSIGHT
 
     [bookmark: pgfId-2639598]You can edit or delete Nmap remediations. For more information, see the following sections:
 
      
      	 [bookmark: pgfId-2703145]Editing an Nmap Remediation
 
      	 [bookmark: pgfId-2703149]Deleting an Nmap Remediation
 
     
 
    
 
     
      [bookmark: pgfId-2632971][bookmark: 49689]Editing an Nmap Remediation
 
     [bookmark: pgfId-3390684]License: FireSIGHT
 
     [bookmark: pgfId-2638798]Modifications you make to Nmap remediations do not affect scans in progress. The new settings take effect when the next scan starts.
 
     [bookmark: pgfId-2638799]To edit an Nmap remediation:
 
     [bookmark: pgfId-3392296]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2638800]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-2638801]The Scanners page appears.
 
     [bookmark: pgfId-2638802]Step 2 Next to the remediation you want to edit, click View. 
 
     [bookmark: pgfId-2638803]The Remediation Edit page appears.
 
     [bookmark: pgfId-2638804]Step 3 Make modifications as necessary.
 
     [bookmark: pgfId-3355929]For information on the settings you can change, see Creating an Nmap Remediation.
 
     [bookmark: pgfId-2638809]Step 4 Click Save, then click Done.
 
     [bookmark: pgfId-2638810]The remediation is modified.
 
     [bookmark: pgfId-3455545]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2632972][bookmark: 88555]Deleting an Nmap Remediation
 
     [bookmark: pgfId-3390700]License: FireSIGHT
 
     [bookmark: pgfId-2639434]Delete an Nmap remediation if you no longer need it.
 
     [bookmark: pgfId-2639435]To delete an Nmap remediation:
 
     [bookmark: pgfId-3392309]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2639436]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-2639437]The Scanners page appears.
 
     [bookmark: pgfId-2639438]Step 2 Next to the remediation you want to delete, click Delete.
 
     [bookmark: pgfId-2639439]Step 3 Confirm that you want to delete the remediation.
 
     [bookmark: pgfId-3110877]The remediation is deleted.
 
     [bookmark: pgfId-3455575]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3355953][bookmark: 48551]Running an On-Demand Nmap[bookmark: marker-3355952] Scan
 
     [bookmark: pgfId-3390718]License: FireSIGHT
 
     [bookmark: pgfId-3355962]You can launch on-demand Nmap scans whenever needed. You can specify the target for an on-demand scan by entering the IP addresses and ports you want to scan or by selecting an existing scan target. 
 
     [bookmark: pgfId-3355963]Note that Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, you may want to set up regularly scheduled scans to keep any Nmap-supplied operating system and server data up to date. For more information, see Automating Nmap Scans. In addition, note that if the host is deleted from the network map, any Nmap scan results are discarded.
 
     [bookmark: pgfId-3355967]To run an on-demand Nmap scan:
 
     [bookmark: pgfId-3392322]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-3355969]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-3355970]The Scanners page appears.
 
     [bookmark: pgfId-3355975]Step 2 Next to the Nmap remediation you want to use to perform the scan, click Scan. 
 
     [bookmark: pgfId-3355976]The Nmap Scan Target dialog box appears.
 
     [bookmark: pgfId-3355981]Step 3 Optionally, to scan using a saved scan target, select a target from the Saved Targets drop-down list and click Load. 
 
     [bookmark: pgfId-3355982]The IP addresses and ports associated with the scan target populate the IP Range(s) and Ports fields.
 
      
       
     
 
     
 
     [bookmark: pgfId-3355985]Tip To create a scan target, click Edit/Add Targets. For more information, see Creating an Nmap Scan Target.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3355987]Step 4 In the IP Range(s) field, specify the IP address for hosts you want to scan or modify the loaded list, up to 255 characters. 
 
     [bookmark: pgfId-3355988]For hosts with IPv4 addresses, you can specify multiple IP addresses separated by commas or use CIDR notation. You can also negate IP addresses by preceding them with an exclamation point (!). For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-3430989]For hosts with IPv6 addresses, use an exact IP address. Ranges are not supported. 
 
     [bookmark: pgfId-3355995]Step 5 In the Ports field, specify the ports you want to scan or modify the loaded list.
 
     [bookmark: pgfId-3355996]You can enter a port number, a list of ports separated by commas, or a range of port numbers separated by a dash. For details on entering ports, see Specifying Ports in Searches.
 
     [bookmark: pgfId-3356000]Step 6 Click Scan Now.
 
     [bookmark: pgfId-3356001]The Nmap server performs the scan.
 
     [bookmark: pgfId-3356002]Note that Nmap validates IP address ranges and displays an error message if the range is invalid. If this occurs, correct the contents of the IP Range(s) field to indicate a valid IP address range.
 
     [bookmark: pgfId-3455586]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2314193][bookmark: 34296]Managing Scan Targ[bookmark: marker-2447692]ets
 
    [bookmark: pgfId-3390739]License: FireSIGHT
 
    [bookmark: pgfId-3397878]When you configure an Nmap module, you can create and save scan targets that identify the hosts and ports you want to target when you perform an on-demand or a scheduled scan, so that you do not have to construct a new scan target every time. A scan target includes a single IP address or a block of IP addresses to scan, as well as the ports on the host or hosts. For Nmap targets, you can also use Nmap octet range addressing or IP address ranges. For more information on Nmap octet range addressing, refer to the Nmap documentation at http://insecure.org.
 
    [bookmark: pgfId-3397880]Note that scans for scan targets containing a large number of hosts can take an extended period of time. As a workaround, scan fewer hosts at a time.
 
    [bookmark: pgfId-3397881]After you create a scan target, you can modify or delete it.
 
    [bookmark: pgfId-2431720]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-2663432]Creating an Nmap Scan Target
 
     	 [bookmark: pgfId-2431538]Editing a Scan Target
 
     	 [bookmark: pgfId-2431593]Deleting a Scan Target
 
    
 
     
      [bookmark: pgfId-2342889][bookmark: 90556]Editing a[bookmark: marker-2565955] Scan Target
 
     [bookmark: pgfId-3390899]License: FireSIGHT
 
     [bookmark: pgfId-2433279]You can modify scan targets you created.
 
      
       
     
 
     
 
     [bookmark: pgfId-2336594]Tip You might want to edit a remediation’s dynamic scan target if you do not want to use the remediation to scan a specific IP address, but the IP address was added to the target because the host was involved in a correlation policy violation that launched the remediation.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2327432]To edit an existing scan target:
 
     [bookmark: pgfId-3392345]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2327433]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-2327434]The Scanners page appears.
 
     [bookmark: pgfId-2327435]Step 2 On the toolbar, click Targets. 
 
     [bookmark: pgfId-2327436]The Scan Target List page appears.
 
     [bookmark: pgfId-2327437]Step 3 Click Edit next to the scan target you want to edit.
 
     [bookmark: pgfId-2327438]The Scan Target page appears.
 
     [bookmark: pgfId-2432852]Step 4 Make modifications as necessary and click Save.
 
     [bookmark: pgfId-2432879]The scan target is updated.
 
     [bookmark: pgfId-3455626]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2314196][bookmark: 76818]Deleting a[bookmark: marker-2565956] Scan Target
 
     [bookmark: pgfId-3390769]License: FireSIGHT
 
     [bookmark: pgfId-2336600]Delete a scan target if you no longer want to scan the hosts listed in it. 
 
     [bookmark: pgfId-2327972]To delete a scan target:
 
     [bookmark: pgfId-3392360]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2327973]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-2433009]The Scanners page appears.
 
     [bookmark: pgfId-2433010]Step 2 On the toolbar, click Targets. 
 
     [bookmark: pgfId-2433011]The Scan Target List page appears.
 
     [bookmark: pgfId-2327977]Step 3 Next to the scan target you want to delete, click Delete.
 
     [bookmark: pgfId-2327978]The scan target is deleted.
 
     [bookmark: pgfId-3455637]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2435634][bookmark: 10633][bookmark: 87342]Working w[bookmark: marker-2447694]ith Active Scan Results
 
    [bookmark: pgfId-3390923]License: FireSIGHT
 
    [bookmark: pgfId-2601078]For information on how to monitor Nmap scans in progress, import results from scans previously performed through the FireSIGHT System or results preformed outside the FireSIGHT System, and view and analyze scan results, see the following sections:
 
     
     	 [bookmark: pgfId-2336988]Viewing Scan Results
 
     	 [bookmark: pgfId-2337031]Understanding the Scan Results Table
 
     	 [bookmark: pgfId-2800178]Analyzing Scan Results
 
     	 [bookmark: pgfId-2800214]Monitoring Scans
 
     	 [bookmark: pgfId-2682603]Importing Scan Results
 
     	 [bookmark: pgfId-3402954]Searching for Scan Results
 
    
 
     
      [bookmark: pgfId-3403031][bookmark: 69713]Viewing Scan Results
 
     [bookmark: pgfId-3403035]License: FireSIGHT
 
     [bookmark: pgfId-3403036]You can view a table of scan results, and then manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-3403037]The page you see when you access scan results differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of scan results. 
 
     [bookmark: pgfId-3403038]You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
      
      
 
      
 
       
        
        [bookmark: pgfId-3403052]Table 47-2 [bookmark: 96976]Scan Results Table Functions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3403056]To... 
          
  
         	 
           
           [bookmark: pgfId-3403058]You can... 
          
  
        
 
         
         	[bookmark: pgfId-3403060]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-3403064]find more information in Understanding the Scan Results Table.
  
        
 
         
         	[bookmark: pgfId-3403067]modify the time and date range for the scan result
  
         	[bookmark: pgfId-3403069]click the time range link. For more information, see Setting Event Time Constraints.
  
        
 
         
         	[bookmark: pgfId-3403074]sort scan results
  
         	[bookmark: pgfId-3403076]click the column title. Click the column title again to reverse the sort order.
  
        
 
         
         	[bookmark: pgfId-3403078]constrain the columns that appear
  . . To add a disabled column back to the view, . 
        
 
         
         	[bookmark: pgfId-3403090]drill down to the next page in the workflow, constraining on a specific value
  
         	[bookmark: pgfId-3403092]use one of the following methods:
 
           
           	 [bookmark: pgfId-3403093]on a drill-down page that you created in a custom workflow, click  a value within a row. Note that clicking a value within a row in a table view constrains the table view and does  not drill down to the next page.
 
           	 [bookmark: pgfId-3403094]To drill down to the next workflow page constraining on some users, select the check boxes next to the users you want to view on the next workflow page, then click  View .
 
           	 [bookmark: pgfId-3403095]To drill down to the next workflow page keeping the current constraints, click  View All .
 
          
 [bookmark: pgfId-3403096]Tip Table views always include “Table View” in the page name. [bookmark: pgfId-3403099]For more information, see Constraining Events.
  
        
 
         
         	[bookmark: pgfId-3403102]configure scan instances and remediations
  
         	[bookmark: pgfId-3403104]Click Scanners in the toolbar.
 [bookmark: pgfId-3403107]For more information, see Setting up Nmap Scans.
  
        
 
         
         	[bookmark: pgfId-3403110]navigate within and between workflow pages
  
         	[bookmark: pgfId-3403114]find more information in Using Workflow Pages.
  
        
 
         
         	[bookmark: pgfId-3403117]navigate to other event views to view associated events
  
         	[bookmark: pgfId-3403119]the name of the event view you want to see from the Jump to drop-down list. For more information, see Navigating Between Workflows.
  
        
 
         
         	[bookmark: pgfId-3403124]search for scan results
  
         	[bookmark: pgfId-3403128]click Search. For more information, see Searching for Scan Results.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3403131]To view scan results:
 
     [bookmark: pgfId-3403132]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-3403133]Step 1 Select Policies > Actions > Scanners.
 
     [bookmark: pgfId-3430283]Step 2 Click Scan Results.
 
     [bookmark: pgfId-3403134]The first page of the default scan results workflow appears. To use a different workflow, including a custom workflow, click (switch workflows) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings.
 
     [bookmark: pgfId-3455657]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3403221][bookmark: 33764]Understanding the Scan Results Table
 
     [bookmark: pgfId-3403226]License: FireSIGHT
 
     [bookmark: pgfId-3403321]When you run an Nmap scan, the Defense Center collects the scan results in a database. The fields in the scan results table are described in the following table.
 
     [bookmark: pgfId-3403433]
 
      
       
        
        [bookmark: pgfId-3403400]Table 47-3 [bookmark: 55207]Scan Results Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-3403404]Field 
          
  
         	 
           
           [bookmark: pgfId-3403406]Description 
          
  
        
 
         
         	[bookmark: pgfId-3403408]Start Time
  
         	[bookmark: pgfId-3403410]The date and time that the scan that produced the results started.
  
        
 
         
         	[bookmark: pgfId-3403412]End Time
  
         	[bookmark: pgfId-3403414]The date and time that the scan that produced the results ended. 
  
        
 
         
         	[bookmark: pgfId-3403416]Scan Target
  
         	[bookmark: pgfId-3403418]The IP address (or host name, if DNS resolution is enabled) of the scan target for the scan that produced the results. 
  
        
 
         
         	[bookmark: pgfId-3403420]Scan Type
  
         	[bookmark: pgfId-3403422]Either Nmap or the name of the third-party scanner to indicate the type of the scan that produced the results.
  
        
 
         
         	[bookmark: pgfId-3403424]Scan Mode
  
         	[bookmark: pgfId-3403426]The mode of the scan that produced the results:
 
           
           	 [bookmark: pgfId-3403427] On  Demand — results from scans run on demand.
 
           	 [bookmark: pgfId-3403428] Imported — results from scans on a different system and imported onto the Defense Center.
 
           	 [bookmark: pgfId-3403460] Scheduled — results from scans run as a scheduled task.
 
          
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3403486][bookmark: 30146]Analyzing Scan [bookmark: marker-3403485]Results
 
     [bookmark: pgfId-3403490]License: FireSIGHT
 
     [bookmark: pgfId-3403491]You can view scan results that you create using the local Nmap module as a rendered page in a pop-up window. You can also download the Nmap results file in raw XML format.
 
     [bookmark: pgfId-3403492]You can also view operating system and server information detected by Nmap in host profiles and in the network map. If a scan of a host produces server information for servers on filtered or closed ports, or if a scan collects information that cannot be included in the operating system information or the servers section, the host profile includes those results in an Nmap Scan Results section. For more information, see Viewing Host Profiles.
 
    
 
     
      [bookmark: pgfId-3403614][bookmark: 74788]Monitoring [bookmark: marker-3403613]Scans
 
     [bookmark: pgfId-3403440]License: FireSIGHT
 
     [bookmark: pgfId-3402617]You can check the progress of an Nmap scan and cancel scan jobs currently in progress. Scan results provide the start time and end time of each scan. Also, after a scan is completed, you can also view the scan results as a rendered page in a pop-up window. Nmap results you can download and view using the Nmap Version 1.01 DTD, available at http://insecure.org. You can also clear scan results.
 
     [bookmark: pgfId-3402619]To monitor a scan:
 
     [bookmark: pgfId-3402620]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-3402621]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-3430398]Step 2 Click Scan Results. 
 
     [bookmark: pgfId-3402622]The first page of the default scan results workflow appears. To use a different workflow, including a custom workflow, click (switch workflows) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-3402626]Tip If you are using a custom workflow that does not include the table view of scan results, click (switch workflows) by the workflow title, then select Scan Results.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3402627]Step 3 You can perform the following actions:
 
      
       
       	 [bookmark: pgfId-3402628]To view the scan results as a rendered page in a pop-up window, click  View next to the scan job.
 
       	 [bookmark: pgfId-3402629]To save a copy of the scan results file so that you can view the raw XML code in any text editor, click  Download next to the scan job.
 
      
 
     
 
     [bookmark: pgfId-3455687]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3403728][bookmark: 54852]Importing Scan [bookmark: marker-3403727]Results
 
     [bookmark: pgfId-3403733]License: FireSIGHT
 
     [bookmark: pgfId-3403734]You can import XML results files created by an Nmap scan performed outside of the FireSIGHT System. You can also import XML results files that you previously downloaded from the FireSIGHT System. To import Nmap scan results, the results file must be in XML format and adhere to the Nmap Version 1.01 DTD. For more information on creating Nmap results and on the Nmap DTD, refer to the Nmap documentation at http://insecure.org. For information on downloading XML results from the FireSIGHT System, see Monitoring Scans.
 
     [bookmark: pgfId-3433345]Note that a host must exist in the network map before Nmap can append its results to the host profile.
 
     [bookmark: pgfId-3403748]To import results:
 
     [bookmark: pgfId-3403749]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-3403750]Step 1 Select Policies > Actions > Scanners. 
 
     [bookmark: pgfId-3403751]The Scan Instances page appears.
 
     [bookmark: pgfId-3403752]Step 2 On the toolbar, click Import Results. 
 
     [bookmark: pgfId-3403753]The Import Results page appears.
 
     [bookmark: pgfId-3403758]Step 3 Click Browse to navigate to the results file. 
 
     [bookmark: pgfId-3403759]Step 4 After you return to the Import Results page, click Import to import the results.
 
     [bookmark: pgfId-3403760]The results file is imported.
 
     [bookmark: pgfId-3455704]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3111819][bookmark: 45584]Searching for[bookmark: marker-2713345] Scan Results
 
     [bookmark: pgfId-3391032]License: FireSIGHT
 
     [bookmark: pgfId-2681325]You can search for Nmap or third-party scan results for any scans run on an appliance or managed appliance in your FireSIGHT System.
 
     [bookmark: pgfId-2681572]
 
      
       
        
        [bookmark: pgfId-2681408]Table 47-4 [bookmark: 54123]Scan Results Search Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-2681412]Field 
          
  
         	 
           
           [bookmark: pgfId-2681414]Search Criteria Rules 
          
  
        
 
         
         	[bookmark: pgfId-2681416]Start Time
  
         	[bookmark: pgfId-2681418]Type the date and time that the scan that produced the results started.
 [bookmark: pgfId-2681775]See Specifying Time Constraints in Searches for the syntax for entering time.
  
        
 
         
         	[bookmark: pgfId-2681760]End Time
  
         	[bookmark: pgfId-2681762]Type the date and time that the scan that produced the results ended. 
 [bookmark: pgfId-2681768]See Specifying Time Constraints in Searches for the syntax for entering time.
  
        
 
         
         	[bookmark: pgfId-2681426]Scan Target
  
         	[bookmark: pgfId-2681428]Type the IP address (or host name, if DNS resolution is enabled) of the scan target for the scan that produced the results. 
 [bookmark: pgfId-2681432]Use a specific IP address or CIDR notation to specify a range of IP addresses. See Specifying IP Addresses in Searches for a full description of the syntax allowed for IP addresses.
  
        
 
         
         	[bookmark: pgfId-2681437]Scan Type
  
         	[bookmark: pgfId-2681439]Type Nmap or a third-party scanner ID to indicate the type of the scan that produced the results.
  
        
 
         
         	[bookmark: pgfId-2681827]Scan Mode
  
         	[bookmark: pgfId-2681829]Type the mode of the scan that produced the results:
 
           
           	 [bookmark: pgfId-2682634]Type  On  Demand to retrieve results from scans run on demand.
 
           	 [bookmark: pgfId-2682639]Type  Imported to retrieve results from scans on a different system and imported onto the Defense Center.
 
           	 [bookmark: pgfId-2682713]Type  Scheduled to retrieve results from scans run as a scheduled task.
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2681573]For more information on searching, including how to load and delete saved searches, see Searching for Events.
 
     [bookmark: pgfId-2681577]To search for scan results:
 
     [bookmark: pgfId-3392434]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2681578]Step 1 Select Analysis > Search, then select Scan Results from the table drop-down list.
 
     [bookmark: pgfId-2681579]The Scan Results search page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-2681584]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2681592]Step 2 Enter your search criteria in the appropriate fields, as described in the Scan Results Search Criteria table.
 
     [bookmark: pgfId-3464355]If you enter criteria for multiple fields, the search returns only the records that match search criteria specified for all fields.
 
     [bookmark: pgfId-3378887]Step 3 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-3378892]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2681600]Step 4 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3464506]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3464507]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3464508]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3464509]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-2772504]Step 5 Click Search to start the search.
 
     [bookmark: pgfId-2772508]Your search results appear. 
 
     [bookmark: pgfId-3455710]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2361666]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2299081][bookmark: 59184]Using [bookmark: marker-2299080]the Network Map 
      
      
 
     
 
 
    [bookmark: pgfId-2307237]The FireSIGHT System passively collects traffic traveling over the network, decodes the data, and then compares it to established operating system and fingerprints. From this information, the system builds a network map, which is a detailed representation of your network. 
 
    [bookmark: pgfId-2059594]The network map allows you to use the Defense Center to view your network topology in terms of hosts and network devices (bridges, routers, NAT devices, and load balancers). It is a useful tool for a quick, overall view of your network. The network map also allows you to drill down on associated host attributes, applications, clients, indications of compromised hosts, and vulnerabilities. In other words, you can select different views of the network map to suit the analysis you perform.
 
    [bookmark: pgfId-2307302]You can augment the information your system collects by adding operating system, application, client, protocol, or host attribute information from a third-party application using the host input feature. You can also actively scan hosts in the network map using Nmap and add the scan results to your network map.
 
    [bookmark: pgfId-2073247]You can use the custom topology feature to help you organize and identify subnets in the views of the network map. For example, if each department in your organization uses a different subnet, you can assign familiar labels to those subnets using the custom topology feature.
 
    [bookmark: pgfId-1995953]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1997800]Understanding the Network Map
 
     	 [bookmark: pgfId-1997807]Working with the Hosts Network Map
 
     	 [bookmark: pgfId-1997811]Working with the Network Devices Network Map
 
     	 [bookmark: pgfId-2354937]Working with the Indications of Compromise Network Map
 
     	 [bookmark: pgfId-2326593]Working with the Mobile Devices Network Map
 
     	 [bookmark: pgfId-1997815]Working with the Applications Network Map
 
     	 [bookmark: pgfId-1997819]Working with the Vulnerabilities Network Map
 
     	 [bookmark: pgfId-1997823]Working with the Host Attributes Network Map
 
     	 [bookmark: pgfId-2048033]Working with Custom Network Topologies
 
    
 
   
 
    
     [bookmark: pgfId-1079979][bookmark: 54487]Understanding the Ne[bookmark: marker-1950497]twork Map
 
    [bookmark: pgfId-2273066]License: FireSIGHT
 
    [bookmark: pgfId-2317052]Each view of the network map has the same format: a hierarchical tree with expandable categories and sub-categories. When you click a category, it expands to show you the sub-categories beneath it. You can select different views of the network map depending on the kind of analysis you are performing.
 
    [bookmark: pgfId-2210630]The Defense Center gathers data from all security zones where discovery policies are applied (including zones that process data from NetFlow-enabled devices). If multiple devices detect the same network asset, the Defense Center combines the information into a composite representation of the asset.
 
    [bookmark: pgfId-2064785]Although you can configure your network discovery policy to add data exported by NetFlow-enabled devices, the available information about these hosts is limited. For example, there is no operating system data available for these hosts, unless you provide it using the host input feature. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
    [bookmark: pgfId-2210598]From any network map, you can view any host’s host profile, which provides a complete view of all the information collected by the system for that host. The host profile contains general information, such as the host name, operating system, and all associated IP addresses, as well as more specific information including detected protocols, applications, indications of compromise, and clients that are running on the host. The host profile also includes information about the vulnerabilities associated with the host and its detected assets. For more information on host profiles, see Using Host Profiles.
 
    [bookmark: pgfId-2007763]You can delete an item from the network map if you are no longer interested in investigating it. You can delete hosts and applications from the network map; you can also delete or deactivate vulnerabilities. If the system detects activity associated with a deleted host, it re-adds the host to the network map. Similarly, deleted applications are re-added to the applications network map if the system detects a change in the application (for example, if an Apache web server is upgraded to a new version). Vulnerabilities are reactivated on specific hosts if the system detects a change that makes the host vulnerable.
 
    [bookmark: pgfId-2303438]You can also use the network map to deactivate vulnerabilities network-wide, which means that you deem these hosts, which the system has judged to be vulnerable, to be safe from that particular attack or exploit.
 
     
      
    
 
    
 
    [bookmark: pgfId-2007814]Tip If you want to permanently exclude a host or subnet from the network map, modify the network discovery policy. You may wish to exclude load balancers and NAT devices from monitoring. They may create excessive and misleading events, filling the database and overloading the Defense Center. See Understanding Host Data Collection for more information.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1657755][bookmark: 78841]Working with the Hosts Net[bookmark: marker-2001324]work Map
 
    [bookmark: pgfId-2273091]License: FireSIGHT
 
    [bookmark: pgfId-2105697]Use the hosts network map to view the hosts on your network, organized by subnet in a hierarchical tree, as well as to drill down to the host profiles for specific hosts. This network map view provides a count of all unique hosts detected by the system, regardless of whether the hosts have one IP address or multiple IP addresses.
 
    [bookmark: pgfId-2073364]Although you can configure your network discovery policy to add hosts to the network map based on data exported by NetFlow-enabled devices, the available information about these hosts is limited. For example, there is no operating system data available for hosts added to the network map using NetFlow data, unless you provide it using the host input feature. 
 
    [bookmark: pgfId-2067036]By creating a custom topology for your network, you can assign meaningful labels to your subnets, such as department names, that appear in the hosts network map.
 
    [bookmark: pgfId-2058562]You can also view the hosts network map according to the organization you specified in the custom topology; see Working with Custom Network Topologies.
 
    [bookmark: pgfId-2059929]You can delete entire networks, subnets, or individual hosts from the hosts network map. For example, if you know that a host is no longer attached to your network, you can delete it from the network map to simplify your analysis. If the system afterwards detects activity associated with the deleted host, it re-adds the host to the network map. If you want to permanently exclude a host or subnet from the network map, modify the network discovery policy. See Creating a Network Discovery Policy for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-2001213]Note Cisco strongly recommends that you do not delete network devices from the network map, because the system uses their locations to determine network topology (including generating network hops and TTL values for monitored hosts). Although you cannot delete network devices from the network devices network map, make sure you do not delete them from the hosts network map.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2122486][bookmark: marker-2122484][bookmark: marker-2122485]To view the hosts network map:
 
    [bookmark: pgfId-2122487]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2122491]Step 1 Select Analysis > Hosts > Network Map, then select the Hosts tab.
 
    [bookmark: pgfId-2328744]The hosts network map appears, displaying a host count and a list of host IP addresses and MAC addresses. Each address or partial address is a link to the next level.
 
    [bookmark: pgfId-2328745]Step 2 Drill down to the specific IP address or MAC address of the host you want to investigate.
 
    [bookmark: pgfId-1084632]For example, to view a host with the IP address 192.168.40.11, click 192, then 192.168, then 192.168.40, then 192.168.40.11. When you click 192.168.40.11, the host profile appears. For more information on host profiles, see Using Host Profiles.
 ). 
    
 ) next to the element you want to delete, then confirm that you want to delete the host or subnet. 
    
 
    [bookmark: pgfId-2001832]The host is deleted. If the system rediscovers the host, it re-adds the host to the network map.
 
    [bookmark: pgfId-2058900]Step 4 Optionally, switch between the hosts view and the topology view of the hosts network map:
 
     
      
      	 [bookmark: pgfId-2059038]To switch to a view of the hosts network map organized by your custom topology, on the hosts view (the default), click  (topology) at the top of the network map.
 
      	 [bookmark: pgfId-2059042]To switch to a view of the hosts network map organized by subnet, on the topology view, click  (hosts) at the top of the network map.
 
     
 
    
 
    [bookmark: pgfId-2059946]For information on configuring custom topologies, see Working with Custom Network Topologies.
 
    [bookmark: pgfId-2373609]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1998426][bookmark: 33116]Working [bookmark: marker-2026000]with the Network Devices Network Map
 
    [bookmark: pgfId-2273124]License: FireSIGHT
 
    [bookmark: pgfId-2108228]Use the network devices network map to view the network devices (bridges, routers, NAT devices, and load balancers) that connect one segment of your network to another, as well as to drill down to the host profiles of those network devices. The network devices network map is separated into two sections: IP and MAC. The IP section lists network devices identified by an IP address; the MAC section lists network devices identified by a MAC address. This network map view also provides a count of all unique network devices detected by the system, regardless of whether the devices have one IP address or multiple IP addresses.
 
    [bookmark: pgfId-2059169]If you create a custom topology for your network, the labels you assign to your subnets appear in the network devices network map.
 
    [bookmark: pgfId-2002739]The methods the system uses to distinguish network devices include:
 
     
     	 [bookmark: pgfId-1897990]the analysis of Cisco Discovery Protocol (CDP) messages, which can identify network devices and their types (Cisco devices only)
 
     	 [bookmark: pgfId-1897992]the detection of the Spanning Tree Protocol (STP), which identifies a device as a switch or bridge
 
     	 [bookmark: pgfId-1897994]the detection of multiple hosts using the same MAC address, which identifies the MAC address as belonging to a router
 
     	 [bookmark: pgfId-2210731]the detection of TTL value changes from the client side, or TTL values that change more frequently than a typical boot time, which identify NAT devices and load balancers
 
    
 
    [bookmark: pgfId-2203525]If a network device communicates using CDP, it may have one or more IP addresses. If it communicates using STP, it may only have a MAC address.
 
    [bookmark: pgfId-2330828]You cannot delete network devices from the network map, because the system uses their locations to determine network topology (including generating network hops and TTL values for monitored hosts).
 
    [bookmark: pgfId-2330853]The host pr[bookmark: marker-2334228]ofile for a network device has a[bookmark: marker-2334250] Systems section rather than an Operating Systems section, which includes a Hardware column that reflects the hardware platform for any mobile devices detected behind the network device. If a value for a hardware platform is listed under Systems, that system represents a mobile device or devices detected behind the network device. Note that mobile devices may or may not have hardware platform information, but hardware platform information is never detected for systems that are not mobile devices.
 
    [bookmark: pgfId-2367118]To view the network devices network map:
 
    [bookmark: pgfId-2367122]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2367123]Step 1 Select Analysis > Hosts > Network Map > Network Devices.
 
    [bookmark: pgfId-1895041]The network devices network map appears, displaying a count of unique network devices and a list of network device IP addresses and MAC addresses. Each address or partial address is a link to the next level of addresses or to the host profile for an individual host.
 
    [bookmark: pgfId-1942845]Step 2 Drill down to the specific IP address or MAC address of the network device you want to investigate.
 
    [bookmark: pgfId-2325021]The host profile for the network device appears. For more information on host profiles, see Using Host Profiles.
 ). 
    
 
    [bookmark: pgfId-2373630]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2354846][bookmark: 86398]Working with the Indications o[bookmark: marker-2359523]f Comprom[bookmark: marker-2359762]ise Network Map
 
    [bookmark: pgfId-2354902]License: FireSIGHT
 
    [bookmark: pgfId-2355495]Use the indications of compromise (IOC) network map to view the compromised hosts on your network, organized by IOC category. Affected hosts are listed beneath each category.
 
    [bookmark: pgfId-2355497]The system uses data from multiple sources to determine a host’s compromised status, including intrusion events, Security Intelligence, and FireAMP.
 
    [bookmark: pgfId-2356083]From the indications of compromise network map, you can view the host profile of each host determined to have been compromised in a specific way. You can also delete (mark as resolved) any IOC category or any specific host, which removes the IOC tag from the relevant hosts. For example, you can delete an IOC category from the network map if you have determined that the issue is addressed and unlikely to recur.
 
    [bookmark: pgfId-2356084]Marking a host or IOC category resolved from the network map does not remove it from your network. A resolved host or IOC category reappears in the network map if your system newly detects information that triggers that IOC.
 
    [bookmark: pgfId-2357226]To view the indications of compromise network map:
 
    [bookmark: pgfId-2357227]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2357228]Step 1 Select Analysis > Hosts > Network Map > Indications of Compromise.
 
    [bookmark: pgfId-2357229]The indications of compromise network map appears.
 
    [bookmark: pgfId-2357231]Step 2 Click the specific IOC category you want to investigate.
 
    [bookmark: pgfId-2357232]For example, if you want to view hosts on which malware was detected, click Malware Detected. 
 ). 
    
 
    [bookmark: pgfId-2357237]Step 3 Drill down to a specific IP address under the IOC category you selected. Each address or partial address is a link to the next level.
 
    [bookmark: pgfId-2357238]The host profile of the compromised host appears with the indications of compromise section expanded. For more information about the IOC section of the host profile, see Working with Indications of Compromise in the Host Profile.
 ) next to the element you want to resolve, then confirm that you want to resolve it. 
    
 
    [bookmark: pgfId-2356079]The category or host is resolved (IOC tags removed). If the IOC is triggered again, it is re-added to the network map.
 
    [bookmark: pgfId-2373650]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2326912][bookmark: 87318]Working with the Mobile [bookmark: marker-2334255]Devices[bookmark: marker-2334240][bookmark: marker-2334245] Network Map
 
    [bookmark: pgfId-2326917]License: FireSIGHT
 
    [bookmark: pgfId-2326918]Use the mobile devices network map to view mobile devices attached to your network, and to drill down to the host profiles for those devices. This network map view also provides a count of all unique mobile devices detected by the system, regardless of whether the devices have one IP address or multiple IP addresses.
 
    [bookmark: pgfId-2326920]The methods the system uses to distinguish mobile devices include:
 
     
     	 [bookmark: pgfId-2326921]analysis of user agent strings in HTTP traffic from the mobile device’s mobile browser 
 
     	 [bookmark: pgfId-2326922]monitoring of HTTP traffic of specific mobile applications
 
    
 
    [bookmark: pgfId-2326925]If you create a custom topology for your network, the labels you assign to your subnets appear in the mobile devices network map.
 
    [bookmark: pgfId-2326926]To view the mobile devices network map:
 
    [bookmark: pgfId-2326927]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2326928]Step 1 Select Analysis > Hosts > Network Map, then select the Mobile Devices tab.
 
    [bookmark: pgfId-2326929]The mobile devices network map appears, displaying a count of unique mobile devices and a list of mobile device IP addresses. Each address or partial address is a link to the next level.
 
    [bookmark: pgfId-2326930]Step 2 Drill down to the specific IP address of the mobile device you want to investigate.
 
    [bookmark: pgfId-2326931]For example, to view a device with the IP address 10.11.40.11, click 10, then 10.11, then 10.11.40, then 10.11.40.11. When you click 10.11.40.11, the host profile appears. For more information on host profiles, see Using Host Profiles.
 ). 
    
 ) next to the element you want to delete, then confirm that you want to delete the device or subnet. 
    
 
    [bookmark: pgfId-2326939]The device is deleted. If the system rediscovers the device, it re-adds the device to the network map.
 
    [bookmark: pgfId-2373682]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2298156][bookmark: 99227]Working with the Applicatio[bookmark: marker-2316100]ns Network Map
 
    [bookmark: pgfId-2273152]License: FireSIGHT
 
    [bookmark: pgfId-2004561]Use the applications network map to view the applications on your network, organized in a hierarchical tree by application name, vendor, version, and finally by the hosts running each application. 
 
    [bookmark: pgfId-2275508]The applications that the system detects may change with system software and VDB updates, and also if you import any add-on detectors. The release notes or advisory text for each system or VDB update contains information on any new and updated detectors. For a comprehensive up-to-date list of detectors, see either of the following Support Sites:
 
     
     	 [bookmark: pgfId-2376646] Cisco: ( http://www.cisco.com/cisco/web/support/index.html )
 
    
 
    [bookmark: pgfId-2067296]From the applications network map, you can view the host profile of each host that runs a specific application as well as delete any application category, any application running on all hosts, or any application running on a specific host. For example, you can delete an application from the network map if you know it is disabled on the host and you want to make sure the system does not use it for impact level qualification.
 
    [bookmark: pgfId-2006114]Deleting an application from the network map does not remove it from your network. A deleted application reappears in the network map if your system detects a change in the application (for example, if an Apache web server is upgraded to a new version) or if you restart your system’s discovery function.
 
    [bookmark: pgfId-2297574]Depending on what you delete, the behavior differs:
 
     
     	 [bookmark: pgfId-2297575]If you delete an application category, the application category is removed from the network map. All applications that reside beneath the category are removed from any host profile that contains the applications.
 
    
 
    [bookmark: pgfId-2006048]For example, if you delete http, all applications identified as http are removed from all host profiles and http no longer appears in the applications view of the network map.
 
     
     	 [bookmark: pgfId-2006049]If you delete a specific application, vendor, or version, the affected application is removed from the network map and from any host profiles that contain it.
 
    
 
    [bookmark: pgfId-2006050]For example, if you expand the http category and delete Apache, all applications listed as Apache with any version listed beneath Apache are removed from any host profiles that contain them. Similarly, if instead of deleting Apache, you delete a specific version (1.3.17, for example), only the version you selected will be deleted from affected host profiles.
 
     
     	 [bookmark: pgfId-2298143]If you delete a specific IP address, the IP address is removed from the application list and the application itself is removed from the host profile of the IP address you selected.
 
    
 
    [bookmark: pgfId-2298132]For example, if you expand http, Apache, 1.3.17 (Win32), and then delete 172.16.1.50:80/tcp, the Apache 1.3.17 (Win32) application is deleted from the host profile of IP address 172.16.1.50.
 
    [bookmark: pgfId-1062535][bookmark: marker-1115967]To view the applications network map:
 
    [bookmark: pgfId-2299406]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2299410]Step 1 Select Analysis > Hosts > Network Map > Applications.
 
    [bookmark: pgfId-2299411]The applications network map appears.
 
    [bookmark: pgfId-2298085]Step 2 Drill down to the specific application you want to investigate.
 
    [bookmark: pgfId-2298086]For example, if you want to view a specific type of web server like Apache, click http, then click Apache, and then click the version of the Apache web server you want to view. 
 ). 
    
 
    [bookmark: pgfId-2298069]Step 3 Click a specific IP address under the application you selected.
 
    [bookmark: pgfId-2298070]The host profile of the host running the application appears with the applications section expanded. For more information about the applications section of the host profile, see Working with Servers in the Host Profile.
 ) next to the element you want to delete, then confirm that you want to delete it. 
    
 
    [bookmark: pgfId-2297967]The application is deleted. If the system rediscovers the application, it is re-added to the network map.
 
    [bookmark: pgfId-2373694]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1657428][bookmark: 73167]Working with the Vulnerabili[bookmark: marker-1950500]ties Ne[bookmark: marker-2007468]twork Map
 
    [bookmark: pgfId-2273207]License: FireSIGHT
 
    [bookmark: pgfId-2082693]Use the vulnerabilities network map to view the vulnerabilities that the system has detected on your network, organized by legacy vulnerability ID (SVID), [bookmark: marker-2082698]Bugtraq ID, [bookmark: marker-2082699]CVE ID, or [bookmark: marker-2082701]Snort ID. [bookmark: marker-2082702]The vulnerabilities are arranged by identification number, with affected hosts listed beneath each vulnerability.
 
    [bookmark: pgfId-2006832]From the vulnerabilities network map, you can view the details of specific vulnerabilities; you can also view the host profile of any host subject to a specific vulnerability. This can help you evaluate the threat posed by that vulnerability to specific affected hosts.
 
    [bookmark: pgfId-2297926]If you deem that a specific vulnerability is not applicable to the hosts on your network (for example, you have applied a patch), you can deactivate the vulnerability. Deactivated vulnerabilities still appear on the network map, but the IP addresses of their previously affected hosts appear in gray italics. The host profiles for those hosts show deactivated vulnerabilities as invalid, though you can manually mark them as valid for individual hosts; see Setting Vulnerabilities for Individual Hosts for more information.
 
    [bookmark: pgfId-2300060]If there is an identity conflict for an application or operating system on a host, the system lists the vulnerabilities for both potential identities. When the identity conflict is resolved, the vulnerabilities remain associated with the current identity. For more information, see Understanding Current Identities and Understanding Identity Conflicts.
 
    [bookmark: pgfId-2300067]By default, the vulnerability network map displays the vulnerabilities of a detected application only if the packet contains the application’s vendor and version. However, you can configure the system to list the vulnerabilities for applications lacking vendor and version data by enabling the vulnerability mapping setting for the application in the system policy. For information on setting the vulnerability mapping for an application, see Mapping Vulnerabilities for Servers.
 
    [bookmark: pgfId-2190513]The numbers next to a vulnerability ID (or range of vulnerability IDs) represent two counts: 
 
     
     	 [bookmark: pgfId-2083220]The first number is a count of non-unique hosts that are affected by a vulnerability or vulnerabilities. If a host is affected by more than one vulnerability, it is counted multiple times. Therefore, it is possible for the count to be higher than the number of hosts on your network. Deactivating a vulnerability decrements this count by the number of hosts that are potentially affected by the vulnerability. If you have not deactivated any vulnerabilities for any of the potentially affected hosts for a vulnerability or range of vulnerabilities, this count is not displayed.
 
     	 [bookmark: pgfId-2083284]The second number is a similar count of the total number of non-unique hosts that the system has determined are  potentially affected by a vulnerability or vulnerabilities.
 
    
 
    [bookmark: pgfId-2304255]Deactivating a vulnerability renders it inactive only for the hosts you designate. You can deactivate a vulnerability for all hosts that have been judged vulnerable or for a specified individual vulnerable host. If the system subsequently detects the vulnerability on a host where it has not been deactivated (for example, on a new host in the network map), the system activates the vulnerability for that host. You have to explicitly deactivate the newly discovered vulnerability. Also, if the system detects an operating system or application change for a host, it may reactivate associated deactivated vulnerabilities.
 
    [bookmark: pgfId-2190487]To view the vulnerabilities network map:
 
    [bookmark: pgfId-2190491]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-1881872]Step 1 Select Analysis > Hosts > Network Map > Vulnerabilities.
 
    [bookmark: pgfId-1893583]The vulnerabilities network map appears.
 
    [bookmark: pgfId-1893588]Step 2 From the Type drop-down list, select the class of vulnerability you want to view. By default, vulnerabilities are displayed by legacy vulnerability ID (SVID).
 
    [bookmark: pgfId-1943304]Step 3 Drill down to the specific vulnerability you want to investigate.
 ). 
    
 
    [bookmark: pgfId-1892925]The vulnerability details appear. For details on the information provided, see Viewing Vulnerability Details.
 
    [bookmark: pgfId-1892930]In addition, on the network map, the Defense Center displays the IP addresses of affected hosts. You can click any IP address to display the host profile for that host.
 
    [bookmark: pgfId-2007195]Step 4 Optionally, deactivate the vulnerability:
 
     
      
      	 [bookmark: pgfId-2007196]To deactivate the vulnerability for all hosts affected by the vulnerability, click the delete icon (
 
     
 
     [image: ] ) next to the vulnerability number. 
    
 
     
      
      	 [bookmark: pgfId-2007200]To deactivate the vulnerability for an individual host, click the delete icon (
 
     
 
     [image: ] ) next to the host’s IP address. 
    
 
    [bookmark: pgfId-2007204]The vulnerability is deactivated. The applicable hosts’ IP addresses appear in gray italics in the network map. In addition, host profiles for those hosts show deactivated vulnerabilities as invalid.
 
     
      
    
 
    
 
    [bookmark: pgfId-2007396]Tip See Setting Vulnerabilities for Individual Hosts for more information on reactivating vulnerabilities.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2373726]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1905625][bookmark: 32556]Working with the Host Attribut[bookmark: marker-1950496]es Network Map[bookmark: marker-1905620]
 
    [bookmark: pgfId-2273234]License: FireSIGHT
 
    [bookmark: pgfId-2108509]Use the host attributes network map to view the hosts on your network organized by their host attributes. When you select the host attribute you want to use to organize your hosts, the Defense Center lists the possible values for that attribute in the network map and groups hosts based on their assigned values. You can also view the host profile of any host assigned a specific host attribute value.
 
    [bookmark: pgfId-2009298]The host attributes network map can organize hosts based on user-defined host attributes. For any of these attributes, the network map displays hosts that do not have a value assigned as Unassigned.
 
    [bookmark: pgfId-2009324]For more information, see Working with User-Defined Host Attributes. 
 
    [bookmark: pgfId-2009306]In addition, the host attributes network map can organize hosts based on the host attributes that correspond to any compliance white lists you have created. Each compliance white list that you create automatically creates a host attribute with the same name as the white list. 
 
    [bookmark: pgfId-2009140]Possible white list host attribute values are:
 
     
     	 [bookmark: pgfId-2009123] Compliant , for hosts that are compliant with the white list
 
     	 [bookmark: pgfId-2009128] Non-Compliant , for hosts that violate the white list
 
     	 [bookmark: pgfId-2009129] Not Evaluated , for hosts that are not valid targets of the white list or have not been evaluated for any reason
 
    
 
    [bookmark: pgfId-2009261]For more information on compliance white lists, see Using the FireSIGHT System as a Compliance Tool.
 
     
      
    
 
    
 
    [bookmark: pgfId-2009346]Note You cannot organize hosts using predefined host attributes, such as host criticality, on the host attributes network map.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1880804]To view the host attributes network map:
 
    [bookmark: pgfId-2112506]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-1897065]Step 1 Select Analysis > Hosts > Network Map > Host Attributes.
 
    [bookmark: pgfId-1900692]The host attributes network map appears.
 
    [bookmark: pgfId-1897077]Step 2 From the Attribute drop-down list, select a host attribute.
 
    [bookmark: pgfId-1880974]The Defense Center lists the values for the host attribute and indicates, in parentheses, the number of hosts assigned that value.
 ). 
    
 
    [bookmark: pgfId-1880975]Step 3 Click any host attribute value to view hosts assigned the value.
 
    [bookmark: pgfId-1881001]Step 4 Click a host IP address to view the host profile for that host.
 
    [bookmark: pgfId-2373767]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2048026][bookmark: 10211]Working with Custom Ne[bookmark: marker-2089247]twork Topologies
 
    [bookmark: pgfId-2273283]License: FireSIGHT
 
    [bookmark: pgfId-2302535]Use the custom topology feature to help you organize and identify subnets in your hosts and network devices network maps. 
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-2059640]For more information about the hosts and network devices network maps, see Working with the Hosts Network Map and Working with the Network Devices Network Map.
 
    [bookmark: pgfId-2208538]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-2208544]Creating Custom Topologies
 
     	 [bookmark: pgfId-2209043]Managing Custom Topologies
 
    
 
     
      [bookmark: pgfId-2209048][bookmark: 43042]Creating Cust[bookmark: marker-2209046]om Topologies
 
     [bookmark: pgfId-2273307]License: FireSIGHT
 
     [bookmark: pgfId-2056737]To create a custom topology, you must specify its networks. You can do this using any or all of three strategies:
 
      
      	 [bookmark: pgfId-2338742]by importing the Cisco-discovered topology, which adds networks using a “best guess” at how your network is deployed based on the hosts and network devices the system has detected
 
      	 [bookmark: pgfId-2338743]by importing networks from a network discovery policy, which adds the networks that you configured the FireSIGHT System to monitor in a network discovery policy
 
      	 [bookmark: pgfId-2338747]by adding networks to your topology manually, if the other two methods create an inaccurate or incomplete representation of your deployment
 
     
 
     [bookmark: pgfId-2056623]You must save and activate the topology before using it with the network map.
 
     [bookmark: pgfId-2055004]To create a custom topology:
 
     [bookmark: pgfId-2108892]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2053515]Step 1 Select Policies > Network Discovery, then click Custom Topology.
 
     [bookmark: pgfId-2053516]The Custom Topology page appears.
 
     [bookmark: pgfId-2053521]Step 2 Click Create Topology.
 
     [bookmark: pgfId-2053522]The Create Topology page appears.
 
     [bookmark: pgfId-2053527]Step 3 Provide basic topology information, such as the topology name and description.
 
     [bookmark: pgfId-2053726]See Providing Basic Topology Information.
 
     [bookmark: pgfId-2054744]Step 4 Add networks to your topology. You can use any or all of the following strategies:
 
      
       
       	 [bookmark: pgfId-2297105]To add networks to your topology by importing the Cisco-discovered topology, follow the procedure in Importing a Discovered Topology.
 
       	 [bookmark: pgfId-2297121]To add networks to your topology by importing them from a network discovery policy, follow the procedure in see Importing Networks from a Network Discovery Policy.
 
       	 [bookmark: pgfId-2056443]To add networks to your topology manually, follow the procedure in Manually Adding Networks to Your Custom Topology.
 
      
 
     
 
     [bookmark: pgfId-2056453]Step 5 Refine your topology:
 
      
       
       	 [bookmark: pgfId-2056490]To remove a network from your custom topology, click  Delete next to the network you want to remove.
 
       	 [bookmark: pgfId-2056488]To rename a network, click  Rename next to the network. In the pop-up window that appears, type the new name in the  Name field and click  Rename . This name labels the network in the network map.
 
      
 
     
 
     [bookmark: pgfId-2053768]Step 6 [bookmark: 94313]Click Save.
 
     [bookmark: pgfId-2053559]The topology is saved.
 
      
       
     
 
     
 
     [bookmark: pgfId-2054700]Note You must activate the topology before you can use it in the network map. For more information, see Managing Custom Topologies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2373817]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2053508][bookmark: 36623]Providing Basic Topology Infor[bookmark: marker-2089249]mation
 
     [bookmark: pgfId-2273327]License: FireSIGHT
 
     [bookmark: pgfId-2054224]You must give each custom topology a name, and, optionally, a short description.
 
     [bookmark: pgfId-2054229]To provide basic topology information:
 
     [bookmark: pgfId-2108904]Access: Admin
 
     
 
     [bookmark: pgfId-2054230]Step 1 On the Edit Topology page, in the Name field, type a name for the topology.
 
     [bookmark: pgfId-2054231]Step 2 Optionally, in the Description field, type a description for the topology.
 
     [bookmark: pgfId-2054239]Step 3 Optionally, continue with the procedures in the following sections, depending on how you want to build your custom topology:
 
      
       
       	 [bookmark: pgfId-2054324]Importing a Discovered Topology
 
       	 [bookmark: pgfId-2054340]Importing Networks from a Network Discovery Policy
 
       	 [bookmark: pgfId-2054352]Manually Adding Networks to Your Custom Topology
 
      
 
     
 
     [bookmark: pgfId-2373844]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2053609][bookmark: 79181]Impo[bookmark: marker-2089250]rting a Discovered Topology
 
     [bookmark: pgfId-2273347]License: FireSIGHT
 
     [bookmark: pgfId-2053615]One way you can add networks to your custom topology is to import the topology discovered by your FireSIGHT System. This discovered topology is the system’s “best guess” at how your network is deployed based on the hosts and network devices it has detected.
 
     [bookmark: pgfId-2057685]To import a discovered topology:
 
     [bookmark: pgfId-2108910]Access: Admin
 
     
 
     [bookmark: pgfId-2054295]Step 1 On the Edit Topology page, click Import Discovered Topology.
 
     [bookmark: pgfId-2057768]Step 2 The discovered networks populate the page.
 
     [bookmark: pgfId-2054366]Step 3 Optionally, continue with the procedures in the following sections, depending on how you want to build your custom topology:
 
      
       
       	 [bookmark: pgfId-2054370]Importing a Discovered Topology
 
       	 [bookmark: pgfId-2054374]Importing Networks from a Network Discovery Policy
 
       	 [bookmark: pgfId-2054378]Manually Adding Networks to Your Custom Topology
 
      
 
     
 
     [bookmark: pgfId-2373868]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2054284][bookmark: 36476]Importing Networks fro[bookmark: marker-2089251]m a Network Discovery Policy
 
     [bookmark: pgfId-2273379]License: FireSIGHT
 
     [bookmark: pgfId-2057792]One way you can add networks to your custom topology is to import the networks that you configured the FireSIGHT System to monitor in a network discovery policy; see Creating a Network Discovery Policy.
 
     [bookmark: pgfId-2054394]To import networks from a network discovery policy:
 
     [bookmark: pgfId-2108942]Access: Admin
 
     
 
     [bookmark: pgfId-2054395]Step 1 [bookmark: 99451]On the Edit Topology page, click Import Policy Networks.
 
     [bookmark: pgfId-2054431]A pop-up window appears.
 
     [bookmark: pgfId-2054396]Step 2 [bookmark: 77662]From the drop-down list, choose the network discovery policy you want to use and click Load.
 
     [bookmark: pgfId-2297278]Step 3 [bookmark: 98270]The monitored networks in your network discovery policy populate the page.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-2055215]Step 4 To add networks from a different network discovery policy, repeat steps 1 and 2.
 
     [bookmark: pgfId-2055207]Step 5 Optionally, follow the procedures in the following sections, depending on how you want to build your custom topology:
 
      
       
       	 [bookmark: pgfId-2054401]Importing a Discovered Topology
 
       	 [bookmark: pgfId-2054409]Manually Adding Networks to Your Custom Topology
 
      
 
     
 
     [bookmark: pgfId-2373891]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2054484][bookmark: 12883]Manually Adding Networks to Your C[bookmark: marker-2089252]ustom Topology
 
     [bookmark: pgfId-2302725]License: FireSIGHT
 
     [bookmark: pgfId-2302726]If importing the Cisco-discovered topology and importing networks from your network discovery policy creates an inaccurate or incomplete representation of your network deployment, you can add networks to your custom topology manually.
 
     [bookmark: pgfId-2054510]To add a network to a custom topology manually:
 
     [bookmark: pgfId-2108977]Access: Admin
 
     
 
     [bookmark: pgfId-2054511]Step 1 [bookmark: 90082]On the Edit Topology page, click Add Network.
 
     [bookmark: pgfId-2055168]A pop-up window appears.
 
     [bookmark: pgfId-2054516]Step 2 Optionally, name the network by typing a name in the Name field.
 
     [bookmark: pgfId-2058377]This name labels the networks in the hosts and network devices network maps after you activate the topology.
 
     [bookmark: pgfId-2055175]For more information, see Working with the Hosts Network Map and Working with the Network Devices Network Map.
 
     [bookmark: pgfId-2058532]Step 3 In the IP Address and Netmask fields, enter the IP address and network mask (in CIDR notation) that represent the network you want to add to your topology. 
 
     [bookmark: pgfId-2055178]For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-2055188]Step 4 [bookmark: 37207]Click Add.
 
     [bookmark: pgfId-2055192]The network is added to your topology.
 
     [bookmark: pgfId-2055193]Step 5 To add additional networks to your topology, repeat steps 1 through 4.
 
      
       
     
 
     
 
     [bookmark: pgfId-2055314]Tip To delete a network from your topology, click Delete next to the network you want to delete, and confirm that you want to delete the network, as well as all links to the network.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2054517]Step 6 Optionally, follow the procedures in the following sections, depending on how you want to build your custom topology:
 
      
       
       	 [bookmark: pgfId-2054521]Importing a Discovered Topology
 
       	 [bookmark: pgfId-2208584]Importing Networks from a Network Discovery Policy
 
      
 
     
 
     [bookmark: pgfId-2373934]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2208632][bookmark: 97710]Managing Custom Topo[bookmark: marker-2208631]logies
 
     [bookmark: pgfId-2273438]License: FireSIGHT
 
     [bookmark: pgfId-2053963]Use the Custom Topology page to manage custom topologies. You can create, modify, and delete topologies.
 
     [bookmark: pgfId-2054045]A topology’s status appears with its name. If the light bulb icon next to the policy name is lit, the topology is active and affects your network map. If it is dark, the topology is inactive. Only one custom topology can be active at any time. If you have created multiple topologies, activating one automatically deactivates the currently active topology.
 
     [bookmark: pgfId-2338155]Use the following procedures to either activate or deactivate a custom topology, modify a topology, or delete a topology. 
 
     [bookmark: pgfId-2338099]If you delete the active topology, your changes take effect immediately; that is, your network map no longer displays your custom topology.
 
     [bookmark: pgfId-2054059]To activate or deactivate a custom topology:
 
     [bookmark: pgfId-2109007]Access: Admin
 
     
 
     [bookmark: pgfId-2054060]Step 1 Select Policies > Network Discovery > Custom Topology.
 
     [bookmark: pgfId-2054061]The Custom Topology page appears.
 
     [bookmark: pgfId-2054062]Step 2 You have two options:
 
      
       
       	 [bookmark: pgfId-2054063]To  activate a topology, click  Activate next to the policy.
 
       	 [bookmark: pgfId-2054064]To  deactivate a topology, click  Deactivate next to the policy.
 
      
 
     
 
     [bookmark: pgfId-2376814]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2054088]To modify a custom topology:
 
     [bookmark: pgfId-2109013]Access: Admin
 
     
 
     [bookmark: pgfId-2054105]Step 1 Select Policies > Network Discovery > Custom Topology.
 
     [bookmark: pgfId-2342377]The Custom Topology page appears.
 ) next to the topology you want to edit. 
     
 
     [bookmark: pgfId-2342384]The Edit Topology page appears. See Creating Custom Topologies for information on the various configurations you can change.
 
     [bookmark: pgfId-2054096]Step 3 Make changes as needed and click Save.
 
     [bookmark: pgfId-2054097]The topology is changed. If the topology is active, the changes you made take effect in the network map immediately.
 
     [bookmark: pgfId-2373951]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2054195]To delete a custom topology:
 
     [bookmark: pgfId-2112424]Access: Admin
 
     
 
     [bookmark: pgfId-2054207]Step 1 Select Policies > Network Discovery > Custom Topology.
 
     [bookmark: pgfId-2054208]The Custom Topology page appears.
 
     [bookmark: pgfId-2338146]Step 2 Click Delete next to the topology you want to delete. If the topology is active, confirm that you want to delete it.
 
     [bookmark: pgfId-2338147]The topology is deleted.
 
     [bookmark: pgfId-2373969]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2338141]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2882542][bookmark: 59184]Using H[bookmark: marker-2815510]ost Profiles 
      
      
 
     
 
 
    [bookmark: pgfId-2956196]A host profile provides a complete view of all the information the system has gathered about a single host. You can access general host information, such as the host name and operating system, through the profile. If you need to quickly find the MAC address for a host, for example, you can look in the host profile.
 
    [bookmark: pgfId-1981455]Host attributes for that host are also listed in the profile. Host attributes are user-defined descriptions that you can apply to a host. For example, you might assign a host attribute that indicates the building where the host is located. From a host profile, you can view the existing host attributes applied to that host and can modify the host attribute values. As another example, you can use the host criticality attribute to designate the business criticality of a given host and to tailor correlation policies and alerts based on host criticality.
 
    [bookmark: pgfId-2582992]Host profiles also provide you with information about the servers, clients, and host protocols running on a particular host, including whether they are in compliance with a compliance white list. You can remove servers from the servers list, and view details for those servers. You can also view connection events for servers, log information about the session where server traffic was detected. You can also view details and connection events for clients and delete servers, clients or host protocols from the host profile.
 
    [bookmark: pgfId-2956518]If your FireSIGHT System deployment includes a FireSIGHT license, you can view indications of compromise (IOC) in the host profile. These indications correlate various types of data (intrusion events, Security Intelligence, connection events, and file or malware events) associated with hosts to determine whether a host on your monitored network is likely to be compromised by malicious means. From the host profile, you can see an overview of a host’s IOC tags, view the events associated with IOC, mark IOC tags resolved, and edit IOC rule states in the discovery policy.
 
    [bookmark: pgfId-2688648]If your deployment includes a Protection license, you can tailor the way the system processes traffic so it best fits the type of operating system on the host and the servers and clients the host is running. For more information, see Tuning Preprocessing in Passive Deployments.
 
    [bookmark: pgfId-2588135]You can also see user history information for a host if you have configured the system to track it. A graphic representation of the last twenty-four hours of user activity is then available.
 
    [bookmark: pgfId-2828548]You can modify the list of vulnerabilities for the host from the host profile. You can use this capability to track which vulnerabilities have been addressed for the host. You can also apply fixes for vulnerabilities, causing all vulnerabilities addressed by the fix to be automatically marked invalid.
 
    [bookmark: pgfId-2776445]You can work with the vulnerability information generated by the Cisco system, and also use information on vulnerabilities detected by third-party scanners, which you import onto the Defense Center using the host input feature.
 
    [bookmark: pgfId-2776449]Optionally, you can perform an Nmap scan from the host profile, to augment the server and operating system information in your host profile. The Nmap scanner actively probes the host to obtain information about the operating system and servers running on the host. The results of the scan are added to the list of operating system and server identities for the host. 
 
    [bookmark: pgfId-2549466]Note that a host profile may not be available for every host on your network. Possible reasons include:
 
     
     	 [bookmark: pgfId-2836370]the host was deleted from the network map because it timed out
 
     	 [bookmark: pgfId-2836371]you have reached your FireSIGHT host license limit
 
     	 [bookmark: pgfId-2836372]the host resides in a network segment that is not monitored by your network discovery policy
 
    
 
    [bookmark: pgfId-2604969]Note that the information displayed in a host profile may vary according to the type of host and the information available about the host. For example, if your system detects a host using a non-IP-based protocol like STP, SNAP, or IPX, the host is added to the network map as a MAC host and much less information is available than for an IP host.
 
    [bookmark: pgfId-2605014]As another example, although you can configure your network discovery policy to add hosts and server and clients to the network map based on data exported by NetFlow-enabled devices, the available information about these hosts and servers and clients is limited. For example, no operating system data is available for these hosts, unless you provide it using a scanner or the host input feature. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     
     [image: ] 
    
 
     
     	 [bookmark: pgfId-1325272]Viewing Host Profiles explains how to access a host profile.
 
     	 [bookmark: pgfId-1983070]Working with Basic Host Information in the Host Profile describes the information provided in the Host section of a host profile.
 
     	 [bookmark: pgfId-2935177]Working with IP Addresses in the Host Profile describes the information provided in the IP Addresses section of a host profile.
 
     	 [bookmark: pgfId-2956024]Working with Indications of Compromise in the Host Profile describes the information provided in the Indications of Compromise section of a host profile.
 
     	 [bookmark: pgfId-2534470]Working with Operating Systems in the Host Profile describes the information provided in the Operating System or Operating System Conflicts section of a host profile and explains how to edit the operating system or resolve an operating system conflict.
 
     	 [bookmark: pgfId-2814478]Working with Servers in the Host Profile describes the information provided in the Servers, Server Detail, and Server Banner sections of a host profile.
 
     	 [bookmark: pgfId-2540774]Working with Applications in the Host Profile describes the information provided in the Clients section of a host profile.
 
     	 [bookmark: pgfId-2534455]Working with VLAN Tags in the Host Profile describes the information provided in the VLAN Tag section of a host profile.
 
     	 [bookmark: pgfId-2176512]Working with User History in the Host Profile describes the information provided in the User History section of a host profile.
 
     	 [bookmark: pgfId-2077138]Working with Host Attributes in the Host Profile describes the information provided in the Attributes section of a host profile.
 
     	 [bookmark: pgfId-2540810]Working with the Predefined Host Attributes explains how to set the host criticality attribute and how to add notes to a host profile.
 
     	 [bookmark: pgfId-2540814]Working with User-Defined Host Attributes, which provides information about creating and using user-defined host attributes.
 
     	 [bookmark: pgfId-1325276]Working with Host Protocols in the Host Profile describes the information provided in the Host Protocols section of a host profile.
 
     	 [bookmark: pgfId-2176356]Working with White List Violations in the Host Profile describes the information provided in the White List Violations section of a host profile.
 
     	 [bookmark: pgfId-2924633]Working with Malware Detections in the Host Profile describes the information provided in the Most Recent Malware Detections section of a host profile.
 
     	 [bookmark: pgfId-2064320]Working with Vulnerabilities in the Host Profile, which describes the information provided in the Vulnerabilities and Vulnerability Detail sections of a host profile.
 
    
 
   
 
    
     [bookmark: pgfId-1885869][bookmark: 59000]Viewing Ho[bookmark: marker-1999408]st Profiles
 
    [bookmark: pgfId-2834974]License: FireSIGHT
 
    [bookmark: pgfId-1885875]You can access a host profile from any network map or from any event view that includes the IP addresses of hosts on monitored networks. For example, the table view of discovery events includes a link to the host profile next to every entry in the IP Address column. If you have any indication of compromise (IOC) rules enabled, potentially compromised hosts appear with a different host profile icon.
 
    [bookmark: pgfId-1885900]To view a host profile from an event view:
 
    [bookmark: pgfId-2317301]Access: Admin/Any Security Analyst
 
    
 ) next to the IP address of the host whose profile you want to view. 
    
 
    [bookmark: pgfId-1983243]The host profile appears in a pop-up window.
 
    [bookmark: pgfId-1900195]To view a host profile from a network map:
 
    [bookmark: pgfId-2842475]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-1900196]Step 1 On any network map, drill down to the IP address of the host whose profile you want to view.
 
    [bookmark: pgfId-1983242]The host profile appears. See Working with the Hosts Network Map for an example of how to access a host profile from a network map.
 
   
 
    
     [bookmark: pgfId-1325298][bookmark: 85302]Working with Basic Host Inform[bookmark: marker-1999407]ation in the Host Profile
 
    [bookmark: pgfId-2834991]License: FireSIGHT
 
    [bookmark: pgfId-2583433]Each host profile provides basic information about a detected host or other device.
 
    [bookmark: pgfId-1901797]Descriptions of each of the basic host profile fields follow. 
 
    [bookmark: pgfId-2930835]IP Addresses
 
    [bookmark: pgfId-2930849]All IP addresses (both IPv4 and IPv6) associated with the host. IPv6 hosts often have at least two IPv6 addresses (local-only and globally routable), and may also have IPv4 addresses. IPv4-only hosts may have multiple IPv4 addresses. Where available, routable host IP addresses also include a flag icon and country code indicating the geolocation data associated with that address. For more information on this and other geolocation features, see Using Geolocation.
 
    [bookmark: pgfId-2912678][bookmark: marker-2912677]Hostname
 
    [bookmark: pgfId-2912680]The fully qualified domain name of the host, if known.
 
    [bookmark: pgfId-2912683]NetBIOS[bookmark: marker-2912682] Name
 
    [bookmark: pgfId-2912685]The NetBIOS name of the host, if available. Microsoft Windows hosts, as well as Macintosh, Linux, or other platforms configured to use NetBIOS, can have a NetBIOS name. For example, Linux hosts configured as Samba servers have NetBIOS names.
 
    [bookmark: pgfId-2912688]Device (Ho[bookmark: marker-2912687]ps)
 
    [bookmark: pgfId-2912690]Either:
 
    [bookmark: pgfId-2912691] – the reporting device for the network where the host resides, as defined in the network discovery policy, or
 
    [bookmark: pgfId-2912692] – the device that processed the NetFlow data that added the host to the network map
 
    [bookmark: pgfId-2912693] – The device and the number of network hops between the device that detected the host and the host itself follows the device name, in parentheses. If multiple devices can see the host, the reporting device is displayed in bold.
 
    [bookmark: pgfId-2912694] – If this field is blank, either:
 
    [bookmark: pgfId-2912695] – the host was added to the network map by a device that is not explicitly monitoring the network where the host resides, as defined in the network discovery policy, or
 
    [bookmark: pgfId-2912696] – the host was added using the host input feature and has not also been detected by the FireSIGHT System
 
    [bookmark: pgfId-2912702]M[bookmark: marker-2912701]AC Addresses ([bookmark: marker-2912703]TTL)
 
    [bookmark: pgfId-2912705]The host’s detected MAC address or addresses and associated NIC vendors, with the NIC’s hardware vendor and current time-to-live (TTL) value in parentheses. If the MAC address is displayed in a bold font, the MAC address is the actual MAC address of the host, detected by the system through ARP and DHCP traffic. If multiple devices detected the host, the Defense Center displays all MAC addresses and TTL values associated with the host, regardless of which device reported them.
 
    [bookmark: pgfId-2912709]You can click the MAC address to view a list of hosts with the same MAC address. Router host profiles typically show the hosts (IP addresses) in the network segments they route in this list, and the IP addresses of monitored routers frequently appear in this list for monitored workstations and servers. The true IP address for the MAC address is displayed in bold.
 
    [bookmark: pgfId-2912712]Host T[bookmark: marker-2912711]ype
 
    [bookmark: pgfId-2912714]The type of device that the system detected: host, mobile device, jailbroken mobile device, router, bridge, NAT device, or load balancer. 
 
    [bookmark: pgfId-2912715]The methods the system uses to distinguish network devices include:
 
    [bookmark: pgfId-2949996] – the analysis of Cisco Discovery Protocol (CDP) messages, which can identify network devices and their type (Cisco devices only)
 
    [bookmark: pgfId-2949997] – the detection of the Spanning Tree Protocol (STP), which identifies a device as a switch or bridge
 
    [bookmark: pgfId-2912718] – the detection of multiple hosts using the same MAC address, which identifies the MAC address as belonging to a router
 
    [bookmark: pgfId-2912719] – the detection of TTL value changes from the client side, or TTL values that change more frequently than a typical boot time, which identify NAT devices and load balancers
 
    [bookmark: pgfId-2912720] – The methods the system uses to distinguish mobile devices include:
 
    [bookmark: pgfId-2912721] – analysis of user agent strings in HTTP traffic from the mobile device’s mobile browser 
 
    [bookmark: pgfId-2912722] – monitoring of HTTP traffic of specific mobile applications
 
    [bookmark: pgfId-2912723]If a device is not identified as a network device or a mobile device, it is categorized as a host.
 
    [bookmark: pgfId-2912731][bookmark: marker-2912730]Last Seen
 
    [bookmark: pgfId-2912734]The date and time [bookmark: marker-2912733]that any of a host’s IP addresses was last detected.
 
    [bookmark: pgfId-2912737]Curre[bookmark: marker-2912736]nt User
 
    [bookmark: pgfId-2912739]The user most recently logged into this host. 
 
    [bookmark: pgfId-2912740]Note that a non-authoritative user logging into a host only registers as the current user on the host if the existing current user is not an authoritative user. For more information, see Users Database.
 
    [bookmark: pgfId-2912745]View
 
    [bookmark: pgfId-2920938]Links to views of event data, using the default workflow for that event type and constrained to show events related to the host; where possible, these events include all IP addresses associated with the host. For more information, see the following sections:
 
    [bookmark: pgfId-2920945] – Content Explorer — for more information, see Using the Context Explorer.
 
    [bookmark: pgfId-2957145] – Connection Events — for more information, see Understanding Connection and Security Intelligence Data.
 
    [bookmark: pgfId-2912758] – Discovery Events — for more information, see Working with Discovery Events.
 
    [bookmark: pgfId-2921827] – Malware Events — for more information, see Working with Malware Events.
 
    [bookmark: pgfId-2912762] – Intrusion Events by Source — for more information, see Working with Intrusion Events.
 
    [bookmark: pgfId-2912766] – Intrusion Events by Destination — for more information, see Working with Intrusion Events.
 
   
 
    
     [bookmark: pgfId-2932515][bookmark: 83575]Working with IP Addresses in the Host Profile
 
    [bookmark: pgfId-2932582]License: FireSIGHT
 
    [bookmark: pgfId-2932617]The system detects IP addresses associated with hosts and, where supported, groups multiple IP addresses used by the same host. IPv6 hosts usually have at least two IPv6 addresses: local-only and globally routable. They may also have one or more assigned IPv4 addresses. IPv4-only hosts may have multiple IPv4 addresses.
 
    [bookmark: pgfId-2969468]The host profile lists all detected IP addresses associated with that host. Where available, IP addresses also feature a small flag icon and ISO country code that indicate the associated country. You can click the flag icon or country code for further geolocation details. For more information, see Using Geolocation.
 
    [bookmark: pgfId-2969472]Note that only the first three addresses are shown by default. Click show all to show all addresses for a host.
 
   
 
    
     [bookmark: pgfId-2955866][bookmark: 55495]Working with Indicatio[bookmark: marker-2971353]ns of Compromise [bookmark: marker-2972377]in the Host Profile[bookmark: marker-2972368]
 
    [bookmark: pgfId-2955938]License: FireSIGHT
 
    [bookmark: pgfId-2955960]The FireSIGHT System can correlate various types of data (intrusion events, Security Intelligence, connection events, and file or malware events) associated with hosts to determine whether a host on your monitored network is likely to be compromised by malicious means. Certain combinations and frequencies of event data trigger indications of compromise (IOC) tags on affected hosts. The Indications of Compromise section of the host profile displays all IOC tags for a host. In this section, you can view details of the threats facing the host, jump to the events that triggered an IOC tag, edit IOC rule states, as well as resolve IOC tags that are no longer relevant.
 
    [bookmark: pgfId-2958725]To use the IOC feature, you must activate the feature and at least one IOC rule in your discovery policy. You can also edit IOC rule states for individual hosts from that host’s host profile page. Each IOC rule corresponds to one type of IOC tag; you can activate any or all rules depending on your organization’s needs. For more information on IOC in the discovery policy and overall, see Understanding Indications of Compromise.
 
    [bookmark: pgfId-2960210]In addition to its presence in the host profile, you can also analyze IOC data in the event viewer. For more information, see Working with Indications of Compromise.
 
    [bookmark: pgfId-2959872]Descriptions of the IOC information fields displayed in the host profile follow.
 
    [bookmark: pgfId-2959978]IP Address
 
    [bookmark: pgfId-2959979]The IP address associated with the host that triggered the IOC. 
 
    [bookmark: pgfId-2959980]Category
 
    [bookmark: pgfId-2959981]Brief description of the type of compromise indicated, such as Malware Executed or Impact 1 Attack.
 
    [bookmark: pgfId-2959982]Event Type
 
    [bookmark: pgfId-2959983]Identifier associated with a specific Indication of Compromise (IOC), referring to the event that triggered it.
 
    [bookmark: pgfId-2959984]Description
 
    [bookmark: pgfId-2959985]Description of what threatens the potentially compromised host, such as This host may be under remote control or Malware has been executed on this host.
 
    [bookmark: pgfId-2959986]First/Last Seen
 
    [bookmark: pgfId-2959987]The first (or most recent) date and time that events triggering a host’s IOC occurred.
 
    [bookmark: pgfId-2959966]For additional information on working with IOC data in the host profile, see the following sections:
 
     
     	 [bookmark: pgfId-2960399]Editing Indication of Compromise Rule States for a Single Host
 
     	 [bookmark: pgfId-2960413]Viewing Source Events for Indications of Compromise
 
     	 [bookmark: pgfId-2960420]Resolving Indications of Compromise
 
    
 
     
      [bookmark: pgfId-2957269][bookmark: 55158]Editing Indication of Compromise Rule States for a Single Host
 
     [bookmark: pgfId-2957842]License: FireSIGHT
 
     [bookmark: pgfId-2961188]For your system to detect and tag indications of compromise (IOC), you must first activate the IOC feature in the discovery policy and activate at least one IOC rule (either policy-wide or for individual hosts). From the host profile, you can set the IOC rule states that apply to that individual host. For more information on configuring IOC in the discovery policy and setting policy-wide IOC rule states, see Setting Indications of Compromise Rules.
 
     [bookmark: pgfId-2970962]From the host profile, you can access and edit the list of IOC rules with the Edit Rule States link in the Indications of Compromise section. You can enable any or all rules, depending on the needs of your network and organization. For example, if hosts using software such as Microsoft Excel never appear on your monitored network, you may decide not to enable the IOC tags that pertain to Excel-based threats.
 
     [bookmark: pgfId-2961714]All IOC rules are predefined by Cisco; you cannot create original rules, although you can write compliance rules against triggered IOC tags. For more information, see Configuring Correlation Policies and Rules. Each IOC rule is triggered by only one type of event (such as malware or intrusion) and corresponds to one specific IOC tag. Both rule and tag have identical Category, Event Type, and Description data for easy correspondence; the Edit page for IOC rule states also lists an event data Source for each rule, to give you a clear picture of what system features you need for a rule to trigger.
 
     [bookmark: pgfId-2963181]To edit Indication of Compromise rule states for a host:
 
     [bookmark: pgfId-2963232]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2963264]Step 1 In a host profile, click Edit Rule States in the Indications of Compromise section.
 
     [bookmark: pgfId-2963351]The Edit Indication of Compromise Rule States page appears in a new window.
 
     [bookmark: pgfId-2963470]Step 2 In the Enabled column for a rule, click the slider to enable or disable it.
 
     [bookmark: pgfId-2963643]Step 3 Click Save.
 
     [bookmark: pgfId-2963682]Your changes are saved.
 
    
 
     
      [bookmark: pgfId-2961020][bookmark: 14757]Viewing Source Events for Indications of Compromise
 
     [bookmark: pgfId-2961024]License: FireSIGHT
 
     [bookmark: pgfId-2963834]You can use the Indications of Compromise section to navigate quickly to the events that triggered IOC tags on a host. Analyzing these events can give you the information you need to determine what, and whether, action is required to address threats to a potentially compromised host.
 ) next to the timestamp of an IOC tag navigates to the table view of events for the relevant event type, constrained to show only the event that triggered the IOC tag. 
     
 
     [bookmark: pgfId-2967750]For more information on the types of events and features that trigger IOC tags, see the following:
 
      
      	 [bookmark: pgfId-2967842]Working with Connection & Security Intelligence Data
 
      	 [bookmark: pgfId-2968015]Working with Intrusion Events
 
      	 [bookmark: pgfId-2968063]Understanding Malware Protection and File Control
 
     
 
     [bookmark: pgfId-2968166]To view source events for an Indications of Compromise tag:
 
     [bookmark: pgfId-2968284]Access: Admin/Any Security Analyst
 
     
 column for the IOC tag you want to investigate. 
     
 
     [bookmark: pgfId-2968706]The table view of events for the appropriate event that triggered the IOC appears, constrained to show only the triggering event. If you are viewing the host profile page in a separate window, the event view appears in the main window.
 
    
 
     
      [bookmark: pgfId-2957843][bookmark: 82649]Resolving Indications of Compromise
 
     [bookmark: pgfId-2957877]License: FireSIGHT
 ). Note that you can still view the IOC-triggering events for the resolved IOC. 
     
 
     [bookmark: pgfId-2969814]If the events that triggered a host’s IOC tag recur, the tag is set again. You can resolve individual IOC tags on a host or mark all of a host’s tags as resolved.
 
     [bookmark: pgfId-2966300]To resolve an Indications of Compromise tag:
 
     [bookmark: pgfId-2966498]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2967047]Step 1 In the host profile’s Indications of Compromise section, you have two options:
 
      
       
       	 [bookmark: pgfId-2966563]To mark an individual IOC tag resolved, click the resolve icon (
 
      
 
      [image: ] ) to the right of the tag you want to resolve. 
     
 
      
       
       	 [bookmark: pgfId-2966870]To mark all IOC tags on a host resolved, click  Mark All Resolved .
 
      
 
     
 
     [bookmark: pgfId-2966973]Your changes are saved and the IOC tags you selected are removed.
 
    
 
   
 
    
     [bookmark: pgfId-2957846][bookmark: 93780]Working with Operating Sy[bookmark: marker-2957845]stems in the Host Profile
 
    [bookmark: pgfId-2835031]License: FireSIGHT
 
    [bookmark: pgfId-2168038]The system passively detects the identity of the operating system running on a host by analyzing the network and application stack in traffic generated by the host or by analyzing host data reported by the User Agent. The system also collates operating system information from other sources, such as the Nmap scanner or application data imported through the host input feature. The system considers the priority assigned to each identity source when determining which identity to use. By default, user input has the highest priority, followed by application or scanner sources, followed by the Cisco-discovered identity.
 
    [bookmark: pgfId-2553055]Sometimes the system supplies a general operating system definition rather than a specific one because the traffic and other identity sources do not provide sufficient information for a more focused identity. The system collates information from the sources to use the most detailed definition possible. 
 
    [bookmark: pgfId-2556036]Descriptions of the operating system information fields displayed in the host profile follow.
 
    [bookmark: pgfId-2913575]Hard[bookmark: marker-2913574]ware
 
    [bookmark: pgfId-2913577]The hardware platform for a mobile device.
 
    [bookmark: pgfId-2913579]OS Vendor/Vendor
 
    [bookmark: pgfId-2913581]The operating system vendor. 
 
    [bookmark: pgfId-2913583]OS Product/Product
 
    [bookmark: pgfId-2913585]The operating system determined most likely to be running on the host, based on the identity data collected from all sources. 
 
    [bookmark: pgfId-2913586]If the operating system is Pending, the system has not yet identified an operating system and no other identity data is available. If the operating system is unknown, the system cannot identify the operating system and no other identity data is available for the operating system.
 
    [bookmark: pgfId-2913587]If the host’s operating system is not one the system is capable of detecting, you may want to use one of the following strategies:
 
    [bookmark: pgfId-2913590] – create a custom fingerprint for the host, as described in Using Custom Fingerprinting
 
    [bookmark: pgfId-2913594] – run an Nmap scan against the host, as described in Scanning a Host from the Host Profile
 
    [bookmark: pgfId-2913596] – import data into the network map, using the host input feature described in the FireSIGHT System Host Input API Guide
 
    [bookmark: pgfId-2913602] – manually enter operating system information, as described in Working with Operating Systems in the Host Profile
 
    [bookmark: pgfId-2913607][bookmark: marker-2913605]OS Versio[bookmark: marker-2913606]n/Version
 
    [bookmark: pgfId-2913610]The operating system version. If a host is a jailbroken m[bookmark: marker-2913609]obile device, Jailbroken is indicated in parentheses after the version.
 
    [bookmark: pgfId-2913613]Sou[bookmark: marker-2913612]rce
 
    [bookmark: pgfId-2913615]One of the following values:
 
    [bookmark: pgfId-2913616] – User: user_name
 
    [bookmark: pgfId-2913617] – Application: app_name
 
    [bookmark: pgfId-2913618] – Scanner: scanner_type (Nmap or scanner added through system policy)
 
    [bookmark: pgfId-2913622] – FireSIGHT
 
    [bookmark: pgfId-2913623]The system may reconcile data from multiple sources to determine the identity of an operating system; see Understanding Current Identities. 
 
    [bookmark: pgfId-2862891]Because the vulnerabilities list for the host and the event impact correlation for events targeting the host depend on the operating system, you may want to manually supply more specific operating system information. In addition, you can indicate that fixes have been applied to the operating system, such as service packs and updates, and invalidate any vulnerabilities addressed by the fixes. 
 
    [bookmark: pgfId-2828542]For example, if the system identifies a host’s operating system as Microsoft Windows 2003, but you know that the host is actually running Microsoft Windows XP Professional with Service Pack 2, you can set the operating system identity accordingly. Setting a more specific operating system identity refines the list of vulnerabilities for the host, so your impact correlation for that host is more focused and accurate.
 
    [bookmark: pgfId-2215415]If the system detects operating system information for a host and that information conflicts with a current operating system identity that was supplied by an active source, an identity conflict occurs. When an identity conflict is in effect, the system uses both identities for vulnerabilities and impact correlation.
 
    [bookmark: pgfId-2859700]Although you can configure the network discovery policy to add hosts to the network map based on data exported by NetFlow-enabled devices, there is no operating system data available for these hosts, unless you set the operating system identity. For more information, see Differences Between NetFlow and FireSIGHT Data.
 ). In addition, if a jailbroken mobile device violates an active white list, the icon appears next to the operating system for the device. 
    
 
    [bookmark: pgfId-2663049]You can set a custom display string for the host’s operating system identity. That display string is then used in the host profile. 
 
     
      
    
 
    
 
    [bookmark: pgfId-2535876]Note Note that changing the operating system information for a host may change its compliance with a compliance white list.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2903578]In the host profile for a network device, the label for the Operating Systems section changes to Sys[bookmark: marker-2905955]tems and an additional Hardware column appears. If a value for a hardware platform is listed under Systems, that system represents a mobile device or devices detected behind the network device. Note that mobile devices may or may not have hardware platform information, but hardware platform information is never detected for systems that are not mobile devices.
 
     
      [bookmark: pgfId-2529252][bookmark: 95855]Viewing Ope[bookmark: marker-2653691]rating System Identities
 
     [bookmark: pgfId-2835053]License: FireSIGHT
 
     [bookmark: pgfId-2540131]You can view the specific operating system identities discovered or added for a host. The system uses source prioritization to determine the current identity for the host. In the list of identities, the current identity is highlighted by boldface text. 
 
     [bookmark: pgfId-2760473]For each operating system identity, the host profile may include the information described in Working with Operating Systems in the Host Profile.
 
     [bookmark: pgfId-2760477]Note that the View button is only available if multiple operating system identities exist for the host. 
 
     [bookmark: pgfId-2557159]To view the list of operating system identities for a host:
 
     [bookmark: pgfId-2842501]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2557094]Step 1 Click View in the Operating System or Operating System Conflicts section of the host profile.
 
     [bookmark: pgfId-2566206]The Operating System Identity Information pop-up window appears. 
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-3000113]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2540009][bookmark: 43906]Editing an Operating Sy[bookmark: marker-2653696]stem
 
    [bookmark: pgfId-2835078]License: FireSIGHT
 
    [bookmark: pgfId-2529450]You can set the current operating system identity for a host using the FireSIGHT System web interface. Setting the identity through the web interface overrides all other identity sources so that identity is used for vulnerability assessment and impact correlation. However, note that if the system detects a conflicting operating system identity for the host after you edit the operating system, an operating system conflict occurs.
 
    [bookmark: pgfId-2556352]Both operating systems are then considered current until you resolve the conflict. For more information, see Resolving Operating System Identity Conflicts.
 
    [bookmark: pgfId-2529257]To change the operating system identity:
 
    [bookmark: pgfId-2842523]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2163867]Step 1 In a host profile, click Edit in the Operating System section.
 
    [bookmark: pgfId-2526394]A pop-up window appears where you can set the operating system identity.
 
    [bookmark: pgfId-2526396]Step 2 You have several options: 
 
     
      
      	 [bookmark: pgfId-2825454]Select  Current Definition from the  OS Definition drop-down list to confirm the current operating system identity through host input, then skip to step  6 .
 
      	 [bookmark: pgfId-2825475]Select a variation on the current operating system identity from the  OS Definition drop-down list, then skip to step  6 . 
 
      	 [bookmark: pgfId-2825479]Select  User-Defined from the  OS Definition drop-down list, then continue with step  3 .
 
     
 
    
 
    [bookmark: pgfId-2164085]Step 3 [bookmark: 64502]Optionally, select Use Custom Display String and modify the custom strings you want to display in the Vendor String, Product String, and Version String fields.
 
    [bookmark: pgfId-2825644]Step 4 Optionally, to change to an operating system from a different vendor, select the vendor and other operating system details from the Vendor and Product drop-down lists.
 
    [bookmark: pgfId-2825646]Step 5 [bookmark: 47183]Optionally, to configure the operating system product release level, select the applicable items in the Major, Minor, Revision, Build, Patch, and Extension drop-down lists.
 
    [bookmark: pgfId-2824550]Step 6 [bookmark: 24073]Optionally, if you want to indicate that fixes for the operating system have been applied, click Configure Fixes.
 
    [bookmark: pgfId-2824551]The list of available package fixes displays.
 
    [bookmark: pgfId-2824633]Step 7 Choose the applicable fixes in the drop-down list and click Add.
 
    [bookmark: pgfId-2825610]Step 8 Optionally, add the relevant patches and extensions using the Patch and Extension drop-down lists.
 
    [bookmark: pgfId-2824552]Step 9 Click Finish to complete the operating system identity configuration.
 
    [bookmark: pgfId-3000131]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2526055][bookmark: 21372]Resolving Operating Syste[bookmark: marker-2653935]m Identity C[bookmark: marker-2653701]onflicts
 
    [bookmark: pgfId-2835098]License: FireSIGHT
 
    [bookmark: pgfId-2529646]An operating system identity conflict occurs when a new identity detected by the system conflicts with the current identity, if that identity was provided by an active source, such as a scanner, application, or user. 
 
    [bookmark: pgfId-2529715]The list of operating system identities in conflict displays in bold in the host profile. 
 
    [bookmark: pgfId-2539909]You can resolve an identity conflict and set the current operating system identity for a host through the system web interface. Setting the identity through the web interface overrides all other identity sources so that identity is used for vulnerability assessment and impact correlation. 
 
    [bookmark: pgfId-2556520]To make one of the conflicting identities current:
 
    [bookmark: pgfId-2842540]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2556738]Step 1 You have two options: 
 
     
      
      	 [bookmark: pgfId-2583050]Click  Make Current next to the operating system identity you want to set as the operating system for the host.
 
      	 [bookmark: pgfId-2583159]If the identity that you  do not want as the current identity came from an active source, delete the unwanted identity. 
 
     
 
    
 
    [bookmark: pgfId-3000151]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2526104]To resolve an operating system identity conflict:
 
    [bookmark: pgfId-2842558]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2526109]Step 1 In a host profile, click Resolve in the Operating System Conflicts section.
 
    [bookmark: pgfId-2526110]A pop-up window appears where you can set the current operating system identity.
 
    [bookmark: pgfId-2556421]Step 2 You have several options: 
 
     
      
      	 [bookmark: pgfId-2556422]Select  Current Definition from the  OS Definition drop-down list to confirm the current operating system identity through host input, then skip to step  6 .
 
      	 [bookmark: pgfId-2556426]Select a variation on one of the conflicting operating system identities from the  OS Definition drop-down list, then skip to step  6 . 
 
      	 [bookmark: pgfId-2556430]Select  User-Defined from the  OS Definition drop-down list, then continue with step  3 .
 
     
 
    
 
    [bookmark: pgfId-2526113]Step 3 [bookmark: 98594]Optionally, select Use Custom Display String and type the custom strings you want to display in the Vendor String, Product String, and Version String fields.
 
    [bookmark: pgfId-2825711]Step 4 Optionally, to change to an operating system from a different vendor, select the vendor and other operating system details. 
 
    [bookmark: pgfId-2825718]Step 5 Optionally, to configure the operating system product release level, select the applicable items in the Major, Minor, Revision, Build, Patch, and Extension drop-down lists.
 
    [bookmark: pgfId-2825713]Step 6 [bookmark: 73259]Optionally, if you want to indicate that fixes for the operating system have been applied, click Configure Fixes.
 
    [bookmark: pgfId-2526115]Step 7 Add the fixes you have applied to the fixes list.
 
    [bookmark: pgfId-2526116]Step 8 Click Finish to complete the operating system identity configuration and return to the host profile.
 
    [bookmark: pgfId-3000176]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2612497][bookmark: 30394]Working with [bookmark: marker-2612496]Servers in the Host Profile
 
    [bookmark: pgfId-2835119]License: FireSIGHT
 
    [bookmark: pgfId-2826125]If the system detects servers running on a host on your monitored network or if servers are added through the host input feature or through a scanner or other active source, the Defense Center lists them in the Servers section of the host profile.
 
    [bookmark: pgfId-2780521]The Defense Center lists up to 100 servers per host. After that limit is reached, new server information from any source, whether active or passive, is discarded until you delete a server from the host or a server times out. For more information, see Host Limits and Discovery Event Logging.
 
    [bookmark: pgfId-2612523]If you scan a host using Nmap, Nmap adds the results of previously undetected servers running on open TCP ports to the Servers list. If you perform an Nmap scan on a host or import Nmap results, an expandable Scan Results section also appears in the host profile, listing the server information detected on the host by the Nmap scan. See Working with Scan Results in a Host Profile and Setting up Nmap Scans for more information. In addition, note that if the host is deleted from the network map, the Nmap scan results for that server for the host are discarded. 
 
     
      
    
 
    
 
    [bookmark: pgfId-2781128]Note Although you can configure your network discovery policy to add server and clients to the network map based on data exported by NetFlow-enabled devices, the available information about these applications is limited. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2612530]The process for working with servers in the host profile differs depending on how you accessed the profile:
 
     
     	 [bookmark: pgfId-2887663]If you accessed the host profile by drilling down through the Servers network map, the details for that server appear with the server name highlighted in bold. If you want to view the details for any other server on the host, click the view icon (
 
     [image: ] ) next to that server name. 
    
 
     
     	 [bookmark: pgfId-2887664]If you accessed the host profile in any other way, expand the Servers section and click the view icon (
 
     [image: ] ) next to the server whose details you want to see. 
    
 
    [bookmark: pgfId-2612533]You can also perform the following actions:
 
     
     	 [bookmark: pgfId-2867096]To analyze the connection events associated with a particular server on the host, click the events icon next to the server.
 
    
 
    [bookmark: pgfId-2867097]The first page of your preferred workflow for connection events appears, showing connection events constrained by the port and protocol of the server, as well as the IP address of the host. If you do not have a preferred workflow for connection events, you must select one. For more information about connection data, see Working with Connection & Security Intelligence Data.
 
     
     	 [bookmark: pgfId-2612540]To delete a server from the host profile, click the delete icon (
 
     [image: ] ) next to the server. 
    
 
    [bookmark: pgfId-2612544]The server is deleted from the host profile, but will appear again if the system detects traffic from the server again. Note that deleting a server from a host may bring the host into compliance with a white list.
 
     
     	 [bookmark: pgfId-2612545]To resolve a server identity conflict, click the resolve icon next to the server.
 
    
 
    [bookmark: pgfId-2612546]You can choose one of the conflicting identities, choose a variation on one of those identities, or set a new user-defined identity.
 
     
     	 [bookmark: pgfId-2612547]To edit a server identity, click the edit icon (
 
     [image: ] ) next to the server. 
    
 
    [bookmark: pgfId-2914548]You can choose the current identity, choose a variation on that identity, or set a new user-defined identity.
 
    [bookmark: pgfId-2914623]Descriptions of the columns in the Servers list follow.
 
    [bookmark: pgfId-2914626][bookmark: marker-2914625]Protocol
 
    [bookmark: pgfId-2914335]The name of the protocol the server uses.
 
    [bookmark: pgfId-2914338][bookmark: marker-2914337]Port 
 
    [bookmark: pgfId-2914340]The port where the server runs.
 
    [bookmark: pgfId-2914343][bookmark: marker-2914342]Application Protocol
 
    [bookmark: pgfId-2914345]One of:
 
    [bookmark: pgfId-2914346] – the name of the application protocol
 
    [bookmark: pgfId-2914347] – pending, if the system cannot positively or negatively identify the application protocol for one of several reasons
 
    [bookmark: pgfId-2914348] – unknown, if the system cannot identify the application protocol based on known application protocol fingerprints or if the server was added through host input by adding a vulnerability with port information without adding a corresponding server
 
    [bookmark: pgfId-2914349]When you hover the mouse on an application protocol name, the tags display. For information on tags, see Understanding Application Detection. 
 
    [bookmark: pgfId-2914354]Vendor and [bookmark: marker-2914355]Version
 
    [bookmark: pgfId-2914359]The vendor and version identified by the FireSIGHT System, by Nmap, or by another active source, or acquired via the host input feature. The field is blank if none of the available sources provides an identification.
 ). 
    
 
    [bookmark: pgfId-2612666]See the following sections for more information:
 
     
     	 [bookmark: pgfId-2612670]Server Detail
 
     	 [bookmark: pgfId-2612682]Editing Server Identities
 
     	 [bookmark: pgfId-2690312]Resolving Server Identity Conflicts
 
    
 
     
      [bookmark: pgfId-2863796][bookmark: 68263]Server Detail
 
     [bookmark: pgfId-2863800]License: FireSIGHT
 
     [bookmark: pgfId-2863810]The Defense Center lists up to 16 passively detected (Cisco- or NetFlow-detected) identities per server. A server can have multiple passive identities if the system detects multiple vendors or versions of that server. For example, a load balancer between your managed device and your web server farm may cause your system to identify multiple passive identities for HTTP if your web servers are not running the same version of the server software. Note that the Defense Center does not limit the number of server identities from active sources such as user input, scanners, or other applications.
 
     [bookmark: pgfId-2863817]The Defense Center displays the current identity in bold. The system uses the current identity of a server for multiple purposes, including assigning vulnerabilities to a host, impact assessment, evaluating correlation rules written against host profile qualifications and compliance white lists, and so on.
 
      
       
     
 
     
 
     [bookmark: pgfId-2863818]Tip For information on changing the server identity and resolving identity conflicts from the server detail, see Editing Server Identities and Resolving Server Identity Conflicts.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2977861]The server detail may also display updated sub-server information known about the selected server. Finally, the server detail may display the server banner, which appears below the server details when you view a server from the host profile.
 
     [bookmark: pgfId-2863836]Server banners provide additional information about a server that may help you identify the server. The system cannot identify or detect a misidentified server when an attacker purposely alters the server banner string. The server banner displays the first 256 bytes of the first packet detected for the server. It is collected only once, the first time the server is detected by the system. Banner content is listed in two columns, with a hexadecimal representation on the left and a corresponding ASCII representation on the right.
 
      
       
     
 
     
 
     [bookmark: pgfId-2863837]Note To view server banners, you must enable the Capture Banners check box in the network discovery policy. This option is disabled by default.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2863838]Descriptions of the information provided in the server detail follow.
 
     [bookmark: pgfId-2914768]Protocol
 
     [bookmark: pgfId-2914770]The name of the protocol the server uses.
 
     [bookmark: pgfId-2914772]Port 
 
     [bookmark: pgfId-2914774]The port where the server runs.
 
     [bookmark: pgfId-2914788][bookmark: marker-2914776][bookmark: marker-2914787]Hits
 
     [bookmark: pgfId-2914793]The number of times the server was detected by a Cisco managed device or Nmap. Note that the number of hits is 0 for servers imported through host input, unless the system detects traffic for that server.
 
     [bookmark: pgfId-2914795]Last Used
 
     [bookmark: pgfId-2914797]The time and date the server was last detected. Note that the last used time for host input data reflects the initial data import time, unless the system detects new traffic for that server. Note also that scanner and application data imported through the host input feature times out according to settings in the system policy, but user input through the Defense Center web interface does not time out. 
 
     [bookmark: pgfId-2914802]Application Protocol
 
     [bookmark: pgfId-2914804]The name of the application protocol used by the server, if known.
 
     [bookmark: pgfId-2914806]Vendor
 
     [bookmark: pgfId-2914808]The server vendor. This field does not appear if the vendor is unknown.
 
     [bookmark: pgfId-2914811][bookmark: marker-2914810]Version
 
     [bookmark: pgfId-2914813]The server version. This field does not appear if the version is unknown.
 
     [bookmark: pgfId-2914816][bookmark: marker-2914815]Source
 
     [bookmark: pgfId-2914818]One of the following values:
 
     [bookmark: pgfId-2914819] – User: user_name
 
     [bookmark: pgfId-2914820] – Application: app_name
 
     [bookmark: pgfId-2929691] – Scanner: scanner_type (Nmap or scanner added through system policy)
 
     [bookmark: pgfId-2929701] – FireSIGHT, FireSIGHT Port Match, or FireSIGHT Pattern Match, for Cisco-detected applications
 
     [bookmark: pgfId-2914835] – NetFlow, for servers added to the network map based on NetFlow data 
 
     [bookmark: pgfId-2914836]The system may reconcile data from multiple sources to determine the identity of a server; see Understanding Current Identities. 
 
     [bookmark: pgfId-2863933]To view the server detail for a server:
 
     [bookmark: pgfId-2864543]Access: Admin/Any Security Analyst
 
     
 section of a host profile. 
     
 
     [bookmark: pgfId-2864545]The Server Detail pop-up window appears.
 
     [bookmark: pgfId-3000188]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2863939][bookmark: 44002]Editing Server Identiti[bookmark: marker-2863938]es
 
     [bookmark: pgfId-2863944]License: FireSIGHT
 
     [bookmark: pgfId-2863945]You can manually update the identity settings for a server on a host and configure any fixes that you have applied to the host to remove the vulnerabilities addressed by the fixes. You can also delete server identities.
 
     [bookmark: pgfId-2863946]Note that deleting an identity does not delete the server, even if that is the only identity. Deleting an identity does remove the identity from the Server Detail pop-up window and, if applicable, updates the current identity for the server in the host profile. 
 
     [bookmark: pgfId-2863950]You cannot edit or delete server identities added by a Cisco-managed device.
 
     [bookmark: pgfId-2863951]To edit the server identity:
 
     [bookmark: pgfId-2863952]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2863953]Step 1 In the Servers section in a host profile, click View to open the Server Detail pop-up window.
 
     [bookmark: pgfId-2863954]Step 2 You have two options:
 
      
       
       	 [bookmark: pgfId-2863958]To delete a server identity, click the delete icon (
 
      
 
      [image: ] ) next to the server identity you want to remove. 
     
 
      
       
       	 [bookmark: pgfId-2863962]To modify a server identity, click the edit icon (
 
      
 
      [image: ] ) next to the server in the servers list. 
     
 
     [bookmark: pgfId-2863963]The Server Identity pop-up window appears. 
 
     [bookmark: pgfId-2863968]Step 3 You have two options:
 
      
       
       	 [bookmark: pgfId-2863969]Select the current definition from the  Select Server Type drop-down list.
 
       	 [bookmark: pgfId-2863970]Select the type of server from the  Select Server Type drop-down list. 
 
      
 
     
 
     [bookmark: pgfId-2863971]Step 4 Optionally, to only list vendors and products for that server type, select the Restrict by Server Type check box. 
 
     [bookmark: pgfId-2863972]Step 5 Optionally, to customize the name and version of the server, select the Use Custom Display String and type a Vendor String and Version String. 
 
     [bookmark: pgfId-2863974]Step 6 In [bookmark: marker-2863973]the Product Mappings section, select the operating system, product, and versions you want to use.
 
     [bookmark: pgfId-2863983]For example, if you want the server to map to Red Hat Linux 9, select Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the version.
 
     [bookmark: pgfId-2863984]Step 7 If you want to indicate that fixes for the server have been applied, click Configure Fixes. Otherwise, skip to step 9.
 
     [bookmark: pgfId-2863988]The Available Package Fixes page appears. 
 
     [bookmark: pgfId-2863993]Step 8 Add the patches you want to apply for that server to the fixes list.
 
     [bookmark: pgfId-2863995]Step 9 [bookmark: 15556]Click Finish to complete the server identity configuration.
 
     [bookmark: pgfId-3000240]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2863998][bookmark: 29496]Resolving Server Identity Con[bookmark: marker-2863997]flicts
 
     [bookmark: pgfId-2864002]License: FireSIGHT
 
     [bookmark: pgfId-2864005]A server identity conflict occurs [bookmark: marker-2864003][bookmark: marker-2864004]when an active source, such as an application or scanner, adds identity data for a server to a host, then the system detects traffic for that port that indicates a conflicting server identity.
 
     [bookmark: pgfId-2864006]To resolve a server identity conflict:
 
     [bookmark: pgfId-2864007]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2864008]Step 1 Click the resolve icon next to the server in the Servers list. 
 
     [bookmark: pgfId-2864009]The Server Identity pop-up window appears. 
 
     [bookmark: pgfId-2864014]Step 2 Select the type of server from the Select Server Type drop-down list. 
 
     [bookmark: pgfId-2864015]Step 3 Optionally, to only list vendors and products for that server type, select the Restrict by Server Type check box. 
 
     [bookmark: pgfId-2864016]Step 4 Optionally, to customize the name and version of the server, select the Use Custom Display String and type a Vendor String and Version String. 
 
     [bookmark: pgfId-2864018]Step 5 In [bookmark: marker-2864017]the Product Mappings section, select the operating system, product, and versions you want to use.
 
     [bookmark: pgfId-2916366]For example, if you want the server to map to Red Hat Linux 9, select Redhat, Inc. as the vendor, Redhat Linux as the product, and 9 as the version.
 
     [bookmark: pgfId-2864028]Step 6 If you want to indicate that fixes for the server have been applied, click Configure Fixes. Otherwise, skip to step 9.
 
     [bookmark: pgfId-2864032]The Available Package Fixes page appears. 
 
     [bookmark: pgfId-2864037]Step 7 Add the patches you want to apply for that server to the fixes list.
 
     [bookmark: pgfId-2864038]Step 8 Click Finish to complete the server identity configuration and return to the host profile.
 
     [bookmark: pgfId-3000291]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2613003][bookmark: 85687]Working with Applications in the Host Profile
 
    [bookmark: pgfId-2835253]License: FireSIGHT
 
    [bookmark: pgfId-2613011]You can see the applications running on a host in the host profile. If you want to remove an application from a host profile, you can delete that application. 
 
    [bookmark: pgfId-2613012]For more information on managing applications in the host profile, see:
 
     
     	 [bookmark: pgfId-2613016]Viewing Applications in the Host Profile
 
     	 [bookmark: pgfId-2613020]Deleting Applications from the Host Profile
 
    
 
     
      [bookmark: pgfId-2613071][bookmark: 53432]Viewing Applicati[bookmark: marker-2876556]ons in the Hos[bookmark: marker-2905985]t Profile
 
     [bookmark: pgfId-2835278]License: FireSIGHT
 
     [bookmark: pgfId-2613082]The system can detect a variety of clients and web applications running on the hosts on your network. 
 
      
       
     
 
     
 
     [bookmark: pgfId-2711598]Note Note that you must select the Applications check box in discovery rules for NetFlow devices in your network discovery policy for the system to detect applications on the hosts in your monitored network. This option is enabled by default in NetFlow rules and cannot be disabled for rules used for discovery via managed devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2711605]The host profile displays the product and version of the detected applications on a host, any available client or web application information, and the time that the application was last detected in use.
 
     [bookmark: pgfId-2934672]The Defense Center lists up to 16 clients running on the host. After that limit is reached, new client information from any source, whether active or passive, is discarded until you delete a client application from the host or the system deletes the client from the host profile due to inactivity (the client times out).
 
     [bookmark: pgfId-2934673]Additionally, for each detected web browser, the host profile displays the first 100 web applications accessed. After that limit is reached, new web applications associated with that browser from any source, whether active or passive, are discarded until either:
 
      
      	 [bookmark: pgfId-2934674]the web browser client application times out, or
 
      	 [bookmark: pgfId-2934675]you delete application information associated with a web application from the host profile
 
     
 
     [bookmark: pgfId-2934663]Descriptions of the application information that appears in a host profile follow.
 
     [bookmark: pgfId-2916412]Application Protocol
 
     [bookmark: pgfId-2916414]Displays the application protocol used by the application (HTTP browser, DNS client, and so on). 
 
     [bookmark: pgfId-2916416]Client 
 
     [bookmark: pgfId-2916418]Client information derived from payload if identified by the FireSIGHT System, or captured by Nmap, or by another active source, or acquired via the host input feature. The field is blank if none of the available sources provides an identification.
 
     [bookmark: pgfId-2916423]Version
 
     [bookmark: pgfId-2916425]Displays the version of the client.
 
     [bookmark: pgfId-2916427]Web Application
 
     [bookmark: pgfId-2916429]For web browsers, the content detected by the system in the http traffic. Web application information indicates the specific type of content (for example, WMV or QuickTime) identified by the FireSIGHT System, captured by Nmap, captured by another active source, or acquired via the host input feature. The field is blank if none of the available sources provides an identification. 
 ). 
     
 ) next to the application. The first page of your preferred workflow for connection events appears, showing connection events constrained by the type, product, and version of the application, as well as the IP address(es) of the host. If you do not have a preferred workflow for connection events, you must select one. For more information about connection data, see 
     Working with Connection & Security Intelligence Data. 
     
 
    
 
     
      [bookmark: pgfId-2613153][bookmark: 46613]Deleting Applications fro[bookmark: marker-2613152]m the Host Profile
 
     [bookmark: pgfId-2834210]License: FireSIGHT
 
     [bookmark: pgfId-2947612]You can delete an application from a host profile to remove applications that you know are not running on the host. Note that deleting an application from a host may bring the host into compliance with a white list.
 
      
       
     
 
     
 
     [bookmark: pgfId-2947613]Note If the system detects the application again, it re-adds it to the network map and the host profile.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2613166]To delete an application from a host profile:
 
     [bookmark: pgfId-2842646]Access: Admin/Any Security Analyst
 
     
 ) next to the application you want to delete. 
     
 
     [bookmark: pgfId-2613172]The application is deleted for that host. 
 
     [bookmark: pgfId-3000303]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2078140][bookmark: 27588]Working with VLAN T[bookmark: marker-2078234]ags in the Host Profile
 
    [bookmark: pgfId-2834227]License: FireSIGHT
 
    [bookmark: pgfId-2078341]The VLAN Tag section of the host profile appears if the host is a member of a Virtual LAN (VLAN). 
 
    [bookmark: pgfId-2586752]Physical network equipment often uses VLANs to create logical network segments from different network blocks. The system detects 802.1q VLAN tags and displays the following information for each:
 
     
     	 [bookmark: pgfId-2078345] VLAN ID identifies the VLAN where the host is a member. This can be any integer between zero and 4095 for 802.1q VLANs.
 
     	 [bookmark: pgfId-2078346] Type identifies the encapsulated packet containing the VLAN tag, which can be either Ethernet or Token Ring. 
 
     	 [bookmark: pgfId-2078347] Priority identifies the priority in the VLAN tag, which can be any integer from zero to 7, where 7 is the highest priority.
 
    
 
    [bookmark: pgfId-2078351]If VLAN tags are nested within the packet, the system processes and the Defense Center displays the innermost VLAN tag. The system collects and the Defense Center displays VLAN tag information only for MAC addresses that it identifies through ARP and DHCP traffic.
 
    [bookmark: pgfId-2078355]VLAN tag information can be useful, for example, if you have a VLAN composed entirely of printers and the system detects a Microsoft Windows 2000 operating system in that VLAN. VLAN information also helps the system generate more accurate network maps.
 
   
 
    
     [bookmark: pgfId-1900906][bookmark: 40214]Working with User His[bookmark: marker-2375274]tory in the Host Profile
 
    [bookmark: pgfId-2834243]License: FireSIGHT
 
    [bookmark: pgfId-2204072]The user history portion of the host profile provides a graphic representation of the last twenty-four hours of user activity. A typical user logs off in the evening and may share the host resource with another user. Periodic login requests, such as those made to check email, are indicated by short regular bars. A list of user identities is provided with bar graphs to indicate when the user login was detected. Note that for non-authoritative logins, the bar graph is gray.
 
    [bookmark: pgfId-2862342]Note that the system does associate a non-authoritative user login to a host with an IP address of that host, so the user does appear in the host’s user history. However, if an authoritative user login is detected for the same host, the user associated with the authoritative user login takes over the association with the host IP address, and new non-authoritative user logins do not disrupt that user association with the host IP address. For more information on the types of users, see Users Database. If you configure capture of failed logins in the network discovery policy, the list includes users that failed to log into the host.
 
   
 
    
     [bookmark: pgfId-2176521][bookmark: 19768]Working [bookmark: marker-2097770]with Host Attributes [bookmark: marker-2097771]in the Host Profile
 
    [bookmark: pgfId-2834262]License: FireSIGHT
 
    [bookmark: pgfId-1900826]You can use host attributes to classify hosts in ways that are important to your network environment. Host attribute values can be positive integers, strings, or URLs. You can also create a list of string values and assign them automatically based on host IP addresses. For information about creating and managing user-defined host attributes, see Working with User-Defined Host Attributes.
 
    [bookmark: pgfId-1986490]The FireSIGHT System includes two predefined host attributes: Host Criticality and Notes. See Working with the Predefined Host Attributes for information about working with these predefined host attributes.
 
    [bookmark: pgfId-2055411]In addition, each compliance white list that you create automatically creates a host attribute with the same name as the white list. Its possible values are Compliant (for hosts that are compliant with the white list), Non-Compliant (for hosts that violate the white list), or Not Evaluated (for hosts that are not valid targets of the white list or have not been evaluated for any reason). You cannot manually change the value of a white list host attribute. For more information on white lists, see Using the FireSIGHT System as a Compliance Tool.
 
     
      [bookmark: pgfId-1922574][bookmark: 10620]Assigning Host Attr[bookmark: marker-2375275]ibute Values
 
     [bookmark: pgfId-2834279]License: FireSIGHT
 
     [bookmark: pgfId-1986625]You can specify positive integers, strings, or URLs as values for existing host attributes.
 
      
       
     
 
     
 
     [bookmark: pgfId-1986757]Tip You can quickly assign host attributes for a host by clicking the Edit link in the Attributes section of the host profile page. This launches a pop-up window containing fields for all the host attributes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1901037]To assign a host attribute value:
 
     [bookmark: pgfId-2842664]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1901038]Step 1 Open a host profile.
 
     [bookmark: pgfId-1901039]Step 2 Under Attributes, click the name of the host attribute to which you want to assign a value.
 
     [bookmark: pgfId-1901040]A pop-up window appears.
 
     [bookmark: pgfId-2055153]Step 3 Enter a value for the attribute or select a value from the drop-down list.
 
     [bookmark: pgfId-1901042]Step 4 Click Save.
 
     [bookmark: pgfId-2054765]The host attribute value is saved.
 
     [bookmark: pgfId-3000315]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1923021][bookmark: 55485]Working with Host Pro[bookmark: marker-1999406]tocols in the Host Profile[bookmark: 54493][bookmark: 51905]
 
    [bookmark: pgfId-2834298]License: FireSIGHT
 
    [bookmark: pgfId-2246217]You can view the protocols running on a host through the host profile. If needed, you can also delete host protocols for a particular host from the profile.
 
    [bookmark: pgfId-2164360]Each host profile contains information about the protocols detected in the network traffic associated with the host.
 
    [bookmark: pgfId-1901320]Descriptions of the protocol and network layer information follow.
 
    [bookmark: pgfId-2916743]Pr[bookmark: marker-2916742]otocol
 
    [bookmark: pgfId-2916745]The name of a protocol used by the host.
 
    [bookmark: pgfId-2916748][bookmark: marker-2916747]Layer
 
    [bookmark: pgfId-2916750]The network layer where the protocol runs (Network or Transport).
 ). 
    
 
    [bookmark: pgfId-2210029]You can delete a protocol from a host profile to remove protocols you know are not running on the host. Note that deleting a protocol from a host may bring the host into compliance with a compliance white list.
 
     
      
    
 
    
 
    [bookmark: pgfId-2206705]Note If the system detects the protocol again, it re-adds it to the network map and the host profile.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2317625]To delete a protocol from a host profile:
 
    [bookmark: pgfId-2886578]Access: Admin/Any Security Analyst
 
    
 ) next to the protocol you want to delete. 
    
 
    [bookmark: pgfId-2166491]The protocol is deleted for that host. 
 
    [bookmark: pgfId-3000335]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2166535][bookmark: 58643]Working with White List Violati[bookmark: marker-2269145]ons in the Host Profile
 
    [bookmark: pgfId-2834323]License: FireSIGHT
 
    [bookmark: pgfId-2177471]A compliance white list (or white list) is a set of criteria that allows you to specify the operating systems, application protocols, clients, web applications, and protocols that are allowed to run on a specific subnet. 
 
    [bookmark: pgfId-2228260]If you add a white list to an active correlation policy, when the system detects that a host is violating the white list, the Defense Center logs a white list event—which is a special kind of correlation event— to the database. Each of these white list events is associated with a white list violation, which indicates how and why a particular host is violating a white list. If a host violates one or more white lists, you can view these violations in its host profile in two ways.
 
    [bookmark: pgfId-2177558]First, the host profile lists all of the individual white list violations associated with the host.
 
    [bookmark: pgfId-2181675]Descriptions of the white list violation information in the host profile follow.
 
    [bookmark: pgfId-2916972]Type
 
    [bookmark: pgfId-2916974]The type of the violation, that is, whether the violation occurred as a result of a non-compliant operating system, application, server, or protocol.
 
    [bookmark: pgfId-2916976]Reason
 
    [bookmark: pgfId-2916978]The specific reason for the violation. For example, if you have a white list that allows only Microsoft Windows hosts, the host profile displays the current operating system running on the host (such as Linux Linux 2.4, 2.6)
 
    [bookmark: pgfId-2916980]White List
 
    [bookmark: pgfId-2916982]The name of the white list associated with the violation.
 ). For example, for a white list that allows only Microsoft Windows hosts, the host profile displays the white list violation icon next to the operating system information for that host. 
    
 
    [bookmark: pgfId-2179437]Note that you can use a host’s profile to create a shared host profile for compliance white lists. For more information, see the next section, Creating a White List Host Profile from a Host Profile.
 
     
      [bookmark: pgfId-2176910][bookmark: 53084]Creating a White List Host Profile from [bookmark: marker-2176909]a Host Profile
 
     [bookmark: pgfId-2834345]License: FireSIGHT
 
     [bookmark: pgfId-2176918]Shared host profiles for compliance white lists specify which operating systems, application protocols, clients, web applications, and protocols are allowed to run on target hosts across multiple white lists. That is, if you create multiple white lists but want to use the same host profile to evaluate hosts running a particular operating system across the white lists, use a shared host profile. 
 
     [bookmark: pgfId-2363539]You can use a host profile of any host with a known IP address to create a shared host profile that your compliance white lists can use. However, note that you cannot create a shared host profile based on an individual host's host profile if the system has not yet identified the operating system of the host. 
 
     [bookmark: pgfId-2317638]To create a shared host profile for compliance white lists based on a host profile:
 
     [bookmark: pgfId-2317639]Access: Admin
 
     
 
     [bookmark: pgfId-2317640]Step 1 Access a host profile from any network map or any event view.
 
     [bookmark: pgfId-2176925]For more information, see Viewing Host Profiles.
 
     [bookmark: pgfId-2176926]Step 2 Click Generate White List Profile.
 
     [bookmark: pgfId-2186159]The Edit Shared Profiles page appears. The fields on the page are pre-populated based on the information in the host profile you accessed.
 
     [bookmark: pgfId-2176928]Step 3 Modify and save the shared host profile according to your specific needs.
 
     [bookmark: pgfId-2176929]For more information on creating shared host profiles for compliance white lists, see Working with Shared Host Profiles.
 
     [bookmark: pgfId-3000379]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2919542][bookmark: 30370]Working with Malware D[bookmark: marker-2928375][bookmark: marker-2928380]etections in the Host Profile
 
    [bookmark: pgfId-2919605]License: FireSIGHT and Malware
 
    [bookmark: pgfId-2919631]The Most Recent Malware Detections section lists the most recent malware events where the host sent or received a malware file, up to 100 events. The host profile lists both network-based and endpoint-based malware events.
 
    [bookmark: pgfId-2923248]If the host is involved in a file event where the file is then retrospectively identified as malware, the original events where the file was transmitted appear in the malware detections list after the malware identification occurs. When a file identified as malware is retrospectively determined not to be malware, the malware events related to that file no longer appear in the list. For example, if a file has a disposition of Malware and that disposition changes to Clean, the event for that file is removed from the malware detections list on the host profile. For more information on malware events, see Working with Malware Events.
 
    [bookmark: pgfId-2919756]Description of the columns in the Most Recent Malware Detections sections of the host profile follow.
 
    [bookmark: pgfId-2919811]Time 
 
    [bookmark: pgfId-2920761]The date and time the event was generated. 
 
    [bookmark: pgfId-2923204]For an event where the file was retrospectively identified as malware, note that this is the time of the original event, not the time when the malware was identified.
 
    [bookmark: pgfId-2919812]Host Role 
 
    [bookmark: pgfId-2920490]The host’s role in the transmission of detected malware, either sender or receiver. Note that for endpoint-based malware events, the host is always the receiver.
 
    [bookmark: pgfId-2919818]Threat Name 
 
    [bookmark: pgfId-2920632]The name of the detected malware.
 
    [bookmark: pgfId-2920706]File Name 
 
    [bookmark: pgfId-2920707]The name of the malware file.
 
    [bookmark: pgfId-2920708]File Type
 
    [bookmark: pgfId-2920462]The type of file; for example, PDF or MSEXE.
 ). 
    
 
   
 
    
     [bookmark: pgfId-2772991][bookmark: 85831]Working with [bookmark: 42095]Vulnerabi[bookmark: marker-2772988]lities[bookmark: 57535] in the Hos[bookmark: marker-2772990]t Profile
 
    [bookmark: pgfId-2834362]License: FireSIGHT
 
    [bookmark: pgfId-2831225]The Vulnerabilities sections of the host profile list the vulnerabilities that affect that host.
 
    [bookmark: pgfId-2866565]The Sourcefire Vulnerabilities section lists vulnerabilities based on the operating system, servers, and applications that the system detected on the host.
 
    [bookmark: pgfId-2830861]If there is an identity conflict for either the identity of the host’s operating system or one of the application protocols on the host, the system lists vulnerabilities for both identities until the conflict is resolved.
 
    [bookmark: pgfId-2773705]Because there is no operating system information available for hosts added to the network map based on NetFlow data, the Defense Center cannot determine which vulnerabilities may affect those hosts, unless you use the host input feature to manually set the hosts’ operating system identity.
 
    [bookmark: pgfId-2866574]Server vendor and version information is often not included in traffic. By default, the system does not map the associated vulnerabilities for the sending and receiving hosts of such traffic. However, using the system policy, you can configure the system to map vulnerabilities for specific application protocols that do not have vendor or version information. For more information, see Mapping Vulnerabilities for Servers.
 
    [bookmark: pgfId-2866578]If you use the host input feature to add third-party vulnerability information for the hosts on your network, additional Vulnerabilities sections appear. For example, if you import vulnerabilities from a QualysGuard Scanner, host profiles on your include a QualysGuard Vulnerabilities section.
 
    [bookmark: pgfId-2886467]You can associate third-party vulnerabilities with operating systems and application protocols, but not clients. For information on importing third-party vulnerabilities, see the FireSIGHT System Host Input API Guide.
 
    [bookmark: pgfId-2785394]Description of the columns in the Vulnerabilities sections of the host profile follow.
 
    [bookmark: pgfId-2917065]Name
 
    [bookmark: pgfId-2917067]The name of the vulnerability.
 
    [bookmark: pgfId-2917069]Remote
 
    [bookmark: pgfId-2917071]Indicates whether the vulnerability can be remotely exploited. If this column is blank, the vulnerability definition does not include this information. 
 
    [bookmark: pgfId-2917073]Component
 
    [bookmark: pgfId-2917075]The name of the operating system, application protocol, or client associated with the vulnerability.
 
    [bookmark: pgfId-2917077]Port
 
    [bookmark: pgfId-2917079]A port number, if the vulnerability is associated with an application protocol running on a specific port.
 
    [bookmark: pgfId-2057968]Keep in mind that for third-party vulnerabilities, the information in the corresponding Vulnerabilities section in the host profile is limited to the information that you provided when you imported the vulnerability data using the host input feature.
 
    [bookmark: pgfId-2774295]When viewing vulnerabilities in the host profile, you can: 
 
     
     	 [bookmark: pgfId-2059118]sort the columns in the  Vulnerabilities sections by clicking a column heading. To reverse the sort, click again.
 
     	 [bookmark: pgfId-2775491]view technical details about a vulnerability, including known solutions, by clicking the name of the vulnerability. See Viewing Vulnerability Details for more information. Note that you can also access vulnerability details from the vulnerability event views or the Vulnerabilities network map.
 
     	 [bookmark: pgfId-2115641]prevent a vulnerability from being used to evaluate impact correlations. See Setting the Vulnerability Impact Qualification for more information.
 
     	 [bookmark: pgfId-2058415]download patches to mitigate the vulnerabilities discovered on the hosts on your network. See Downloading Patches for Vulnerabilities for more information.
 
     	 [bookmark: pgfId-1911214]mark hosts as not vulnerable to individual vulnerabilities if you know that the hosts have been patched. See Setting Vulnerabilities for Individual Hosts for more information.
 
    
 
     
      [bookmark: pgfId-1686166][bookmark: 46953]Viewing Vulnerability [bookmark: marker-2099620]Details
 
     [bookmark: pgfId-2834379]License: FireSIGHT
 
     [bookmark: pgfId-2946481]Vulnerability details include a technical description of the vulnerability and known solutions.
 ) next to the SVID. You can also access vulnerability details from the network map and the host profile. 
     
 
     [bookmark: pgfId-2917680]Descriptions of the fields on the Vulnerability Detail page follow.
 
     [bookmark: pgfId-2917692][bookmark: marker-2917688]Cisco Vulnerability ID
 
     [bookmark: pgfId-2917693]The identification number (SVID) that the system uses to track vulnerabilities.
 
     [bookmark: pgfId-2917695][bookmark: marker-2917694]Snort ID
 
     [bookmark: pgfId-2917696]The identification number associated with the vulnerability in the Snort ID (SID) database. That is, if an intrusion rule can detect network traffic that exploits a particular vulnerability, that vulnerability is associated with the intrusion rule’s SID. 
 
     [bookmark: pgfId-2917697]Note that a vulnerability can be associated with more than one SID (or no SIDs at all). If the vulnerability does not have an associated SID, this field does not appear.
 
     [bookmark: pgfId-2917699][bookmark: marker-2917698]BugTraq ID
 
     [bookmark: pgfId-2917700]The identification number associated with the vulnerability in the Bugtraq database (http://www.securityfocus.com/bid).
 
     [bookmark: pgfId-2917703][bookmark: marker-2917702]CVE ID
 
     [bookmark: pgfId-2917704]The identification number associated with the vulnerability in MITRE’s Common Vulnerabilities and Exposures (CVE) database (http://www.cve.mitre.org/).
 
     [bookmark: pgfId-2917707]Title
 
     [bookmark: pgfId-2917708]The title of the vulnerability.
 
     [bookmark: pgfId-2917710][bookmark: marker-2917709]Impact Qualification
 
     [bookmark: pgfId-2917714]Use the drop-down list to enable or disable a vulnerability. The Defense Center ignores disabled vulnerabilities in its impact correlations. 
 
     [bookmark: pgfId-2917715]The setting you specify here determines how the vulnerability is treated on a system-wide basis and is not limited to the host profile where you select the value. See Setting the Vulnerability Impact Qualification for information about using this feature to enable and disable a vulnerability.
 
     [bookmark: pgfId-2917720][bookmark: marker-2917719]Date Published
 
     [bookmark: pgfId-2917721]The date that the vulnerability was published.
 
     [bookmark: pgfId-2917723]Vulnerability [bookmark: marker-2917722]Impact
 
     [bookmark: pgfId-2917724]The severity assigned to the vulnerability in the Bugtraq database on a scale of 1 to 10, with 10 being the most severe. The vulnerability impact is determined by the writer of the Bugtraq entry, who determines the vulnerability impact level based on his or her best judgment, guided by SANS Critical Vulnerability Analysis (CVA) criteria. 
 
     [bookmark: pgfId-2917726][bookmark: marker-2917725]Remote
 
     [bookmark: pgfId-2917727]Indicates whether the vulnerability is remotely exploitable.
 
     [bookmark: pgfId-2917729][bookmark: marker-2917728]Available Exploits
 
     [bookmark: pgfId-2917730]Indicates whether there are known exploits for the vulnerability.
 
     [bookmark: pgfId-2917732][bookmark: marker-2917731]Description
 
     [bookmark: pgfId-2917733]Summary description of the vulnerability.
 
     [bookmark: pgfId-2917735][bookmark: marker-2917734]Technical Description
 
     [bookmark: pgfId-2917736]Detailed technical description of the vulnerability.
 
     [bookmark: pgfId-2917738][bookmark: marker-2917737]Solution
 
     [bookmark: pgfId-2917739]Information about repairing the vulnerability.
 
     [bookmark: pgfId-2917741][bookmark: marker-2917740]Additional Information
 
     [bookmark: pgfId-2917742]Click the arrow to view additional information (if available) about the vulnerability, such as known exploits and their availability, exploit scenarios, and mitigation strategies.
 
     [bookmark: pgfId-2917744][bookmark: marker-2917743]Fixes
 
     [bookmark: pgfId-2917745]Provides links to downloadable patches for the selected vulnerability.
 
      
       
     
 
     
 
     [bookmark: pgfId-2917746]Tip If direct links to fix or patch downloads appear, right-click the link and save it to your local computer.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2917751][bookmark: 74449]Setting [bookmark: marker-2917749]the Vuln[bookmark: marker-2917750]erability Impact Qualification
 
     [bookmark: pgfId-2834403]License: FireSIGHT
 
     [bookmark: pgfId-2115678]If the system reports a vulnerability that is not applicable to your network, you can prevent it from being used to evaluate impact flag correlations. Note that if you deactivate a vulnerability in a host profile, it deactivates it for all hosts on your network. You can, however, reactivate it at any time.
 
     [bookmark: pgfId-2828278]When a conflict exists for the identity of the host’s operating system or one of the applications on the host, the system lists vulnerabilities for both conflicting identities until the conflict is resolved. For more information, see Understanding Identity Conflicts and Resolving Operating System Identity Conflicts.
 
     [bookmark: pgfId-2886255]Note also that the system does not recommend a rule state for an intrusion rule based on a vulnerability that you disable using the Impact Qualification feature. For more information, see Tailoring Intrusion Protection to Your Network Assets.
 
      
       
     
 
     
 
     [bookmark: pgfId-2886259]Tip You can also deactivate vulnerabilities from the network map and from vulnerability event views. For more information, see Working with the Vulnerabilities Network Map and Deactivating Vulnerabilities.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2115686]To change the use of a vulnerability across the system:
 
     [bookmark: pgfId-2847907]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2115687]Step 1 Access the host profile of a host affected by the vulnerability you want to deactivate. 
 
     [bookmark: pgfId-2115691]Step 2 Expand the Vulnerabilities section.
 
     [bookmark: pgfId-2115692]Step 3 Click the name of the vulnerability you want to enable or disable.
 
     [bookmark: pgfId-2115695]A pop-up window appears with the vulnerability details. For more information, see Viewing Vulnerability Details.
 
     [bookmark: pgfId-2115697]Step 4 Select Disabled or Enabled from the Impact Qualification drop-down list to specify how the vulnerability is used.
 
     [bookmark: pgfId-2115698]Step 5 Confirm that you want to change the Impact Qualification for all hosts on the network map.
 
     [bookmark: pgfId-2115699]The vulnerability is enabled or disabled.
 
     [bookmark: pgfId-2115700]Step 6 Click Done to close the vulnerability details pop-up window.
 
    
 
     
      [bookmark: pgfId-1911427][bookmark: 97716]Downloading Patches [bookmark: marker-2100375]for Vulnerabilities
 
     [bookmark: pgfId-2834420]License: FireSIGHT
 
     [bookmark: pgfId-1911433]If they are available, you can download patches to mitigate the vulnerabilities discovered on the hosts on your network.
 
     [bookmark: pgfId-1911485]To download a patch for a vulnerability:
 
     [bookmark: pgfId-2317773]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2059391]Step 1 Access the host profile of a host for which you want to download a patch.
 
     [bookmark: pgfId-2059395]Step 2 Expand the Vulnerabilities section.
 
     [bookmark: pgfId-1911494]Step 3 Click the name of the vulnerability you want to patch.
 
     [bookmark: pgfId-2059512]The Vulnerability Detail page appears.
 
     [bookmark: pgfId-1911503]Step 4 Expand the Fixes section.
 
     [bookmark: pgfId-1911824]The list of downloadable patches for the vulnerability appears.
 
     [bookmark: pgfId-1911865]Step 5 Click Download next to the patch you want to download.
 
     [bookmark: pgfId-1911986]A download page from the patch vendor appears.
 
     [bookmark: pgfId-2059664]Step 6 Download the patch and apply it to your affected systems.
 
     [bookmark: pgfId-3000397]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1401318][bookmark: 40481]Setting [bookmark: marker-1694493]Vulnerabilities for Individual Hosts
 
     [bookmark: pgfId-2834437]License: FireSIGHT
 
     [bookmark: pgfId-1692506]You can use the host vulnerability editor to activate or deactivate vulnerabilities on a host-by-host basis. When you deactivate a vulnerability for a host, it is still used for impact correlations for that host, but the impact level is automatically reduced one level.
 
     [bookmark: pgfId-1692518]To activate or deactivate a vulnerability for a single host:
 
     [bookmark: pgfId-2317800]Access: Admin/Security Analyst
 
     
 
     [bookmark: pgfId-1882789]Step 1 Open a host profile.
 
     [bookmark: pgfId-1692432]Step 2 Next to Vulnerabilities, click Edit.
 
     [bookmark: pgfId-1901739]The Host Vulnerabilities editor page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-2080096]Tip To view details about a vulnerability, select it and click View. For more information, see Viewing Vulnerability Details.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2080094]Step 3 You have two options:
 
      
       
       	 [bookmark: pgfId-1973802]To deactivate a vulnerability, select it from the  Valid Vulnerabilities list, then click the down arrow.
 
       	 [bookmark: pgfId-1884147]To activate a vulnerability, select it from the  Invalid Vulnerabilities list, then click the up arrow.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2080025]Tip Use Ctrl or Shift while clicking to select multiple vulnerabilities. You can click and drag to select multiple adjacent vulnerabilities; you can also double-click any vulnerability to move it from list to list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1973839]Step 4 Click Save.
 
     [bookmark: pgfId-2931839]Your changes are saved.
 
     [bookmark: pgfId-3000433]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1949706][bookmark: 84713]Working with the Predefin[bookmark: marker-1999396]ed Host Att[bookmark: marker-1949705]ributes
 
    [bookmark: pgfId-2834454]License: FireSIGHT
 
    [bookmark: pgfId-1949710]There are two predefined host attributes that you can assign to each host: host criticality and host-specific notes. Use the host criticality attribute to designate the business criticality of a given host and to tailor correlation policies and alerts based on host criticality. For example, if you consider your organization’s mail servers more critical to your business than a typical user workstation, you can assign a value of High to your mail servers and other business-critical devices and Medium or Low to other hosts. You can then create a correlation policy that launches different alerts based on the criticality of an affected host.
 
    [bookmark: pgfId-2886050]Use the Notes feature to record information about the host that you want other analysts to view. For example, if you have a computer on the network that has an older, unpatched version of an operating system that you use for testing, you can use the Notes feature to indicate that the system is intentionally unpatched.
 
    [bookmark: pgfId-1949731]To set pre-defined host attributes in the host profile:
 
    [bookmark: pgfId-2324085]Access: Admin/Security Analyst
 
    
 
    [bookmark: pgfId-1949732]Step 1 Open the host profile for the host for which you want to set a business criticality.
 ). 
    
 
    [bookmark: pgfId-1949734]The Host Attributes pop-up window appears.
 
    [bookmark: pgfId-1949735]Step 3 Form the Host Criticality drop-down list, select the value you want to apply: None, Low, Medium, or High.
 
    [bookmark: pgfId-1949736]Step 4 Click Save.
 
    [bookmark: pgfId-1949737]Your selection is saved.
 
    [bookmark: pgfId-3000465]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2105870][bookmark: 16984]Working with[bookmark: marker-2105928] User-Defined Host Attributes
 
    [bookmark: pgfId-2834527]License: FireSIGHT
 
    [bookmark: pgfId-2105875]The FireSIGHT System includes two predefined host attributes, host criticality and host notes, that you can use to indicate the business criticality of the hosts on your network. If you have other criteria that you would like to use to identify your hosts, you can create user-defined host attributes.
 
    [bookmark: pgfId-1948681]User-defined host attributes appear in the host profile page, where you can assign values on a per-host basis. You can then use those attributes in correlation policies and searches. You can also view the attributes on the host attribute table view of events and generate reports based on them.
 
     
      
    
 
    
 
    [bookmark: pgfId-2826520]Note Host attributes are defined globally rather than per policy. After you create a host attribute, it is available regardless of the policy applied.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1871425]Some examples of user-defined host attributes include:
 
     
     	 [bookmark: pgfId-1871426]assigning physical location identifiers to hosts, such as a facility code, city, or room number.
 
     	 [bookmark: pgfId-1871427]assigning a Responsible Party Identifier that indicates which system administrator is responsible for a given host. You can then craft correlation rules and policies to send alerts to the correct system administrator when problems related to a host are detected.
 
    
 
    [bookmark: pgfId-1948376]Host attributes can be text strings or values selected from predefined lists of text or ranges of numbers. You can also automatically assign values to hosts from a predefined list based on the hosts’ IP addresses. You can use this feature to automatically assign values to new hosts when they appear on your network for the first time.
 
    [bookmark: pgfId-1950951]Host attributes [bookmark: marker-2101200]can be one of the following types:
 
    [bookmark: pgfId-2918129][bookmark: marker-2918128]Text
 
    [bookmark: pgfId-2918131]Allows you to manually assign a text string up to 255 characters to a host.
 
    [bookmark: pgfId-2918134][bookmark: marker-2918133]Integer
 
    [bookmark: pgfId-2918136]Allows you to specify the first and last number of a range of positive integers, then manually assign one of these numbers to a host.
 
    [bookmark: pgfId-2918139][bookmark: marker-2918138]List
 
    [bookmark: pgfId-2918141]Allows you to create a list of string values, then manually assign one of the values to a host. You can also automatically assign values to hosts based on the host’s IP addresses. 
 
     
      
    
 
    
 
    [bookmark: pgfId-2952691]Note If you auto-assign values based on one IP address of a host with multiple IP addresses, those values will apply across all addresses associated with that host. Keep this in mind when you view the Host Attributes table.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2918144][bookmark: marker-2918143]URL
 
    [bookmark: pgfId-2918146]Allows you to manually assign a URL value to a host.
 
    [bookmark: pgfId-2059928]Note that each compliance white list that you create automatically creates a host attribute with the same name as the white list. Its possible values are Compliant (for hosts that are compliant with the white list), Non-Compliant (for hosts that violate the white list), and Not Evaluated (for hosts that are not valid targets of the white list or have not been evaluated for any reason). You cannot manually change the value of a white list host attribute. For more information on white lists, see Using the FireSIGHT System as a Compliance Tool.
 
    [bookmark: pgfId-2831816]See the following sections for more information:
 
     
     	 [bookmark: pgfId-2831824]Creating User-Defined Host Attributes
 
     	 [bookmark: pgfId-2831423]Editing a User-Defined Host Attribute
 
     	 [bookmark: pgfId-1951624]Deleting a User-Defined Host Attribute
 
    
 
     
      [bookmark: pgfId-2308624][bookmark: 92191]Creating User-Defined Ho[bookmark: marker-2308623]st Attributes
 
     [bookmark: pgfId-2756422]License: FireSIGHT
 
     [bookmark: pgfId-2826545]The following procedure explains how to create a user-defined host attribute. 
 
      
       
     
 
     
 
     [bookmark: pgfId-2826569]Note Host attributes are defined globally rather than per policy. After you create a host attribute, it is available regardless of the policy applied.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2308627][bookmark: marker-2308626]To create a new host attribute:
 
     [bookmark: pgfId-2826758]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2826759]Step 1 Select Analysis > Hosts > Host Attributes.
 
     [bookmark: pgfId-2826760]The Host Attributes page appears.
 
     [bookmark: pgfId-2857209]Step 2 Click Host Attribute Management.
 
     [bookmark: pgfId-2857224]The Host Attribute Management page appears.
 
     [bookmark: pgfId-1873137]Step 3 Click Create Attribute.
 
     [bookmark: pgfId-1908035]The Create Attribute page appears.
 
     [bookmark: pgfId-1951453]Step 4 In the Name field, type a name for the host attribute using alphanumeric characters and spaces.
 
     [bookmark: pgfId-1951706]Step 5 Select the type of attribute that you want to create from the Type drop-down list, as described in Working with Host Attributes in the Host Profile:
 
      
       
       	 [bookmark: pgfId-1951727]If you are creating a  Text or  URL host attribute, continue with step  6 .
 
       	 [bookmark: pgfId-2059968]If you are creating an  Integer host attribute, see Creating Integer Host Attributes.
 
       	 [bookmark: pgfId-2060003]If you are creating a  List host attribute, see Creating List Host Attributes.
 
      
 
     
 
     [bookmark: pgfId-2060007]Step 6 [bookmark: 29643]Click Save.
 
     [bookmark: pgfId-1951891]The new user-defined host attribute is saved.
 
     [bookmark: pgfId-3000492]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1951217][bookmark: 28161]Creating [bookmark: marker-2101207]Integer Host Attributes
 
     [bookmark: pgfId-2834562]License: FireSIGHT
 
     [bookmark: pgfId-1951218]When you define an integer-based host attribute, you must specify the range of numbers that the attribute accepts.
 
     [bookmark: pgfId-2060080]To create an integer-based host attribute:
 
     [bookmark: pgfId-2858075]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2060136]Step 1 In the Min field, enter the minimum integer value that can be assigned to a host.
 
     [bookmark: pgfId-1951234]Step 2 In the Max field, enter the maximum integer value that can be assigned to a host.
 
     [bookmark: pgfId-2931946]Step 3 Click Save.
 
     [bookmark: pgfId-2931959]The new integer-based host attribute is saved.
 
     [bookmark: pgfId-3000512]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1952793][bookmark: 18054]Creating [bookmark: marker-2101208]List Host Attributes
 
     [bookmark: pgfId-2834586]License: FireSIGHT
 
     [bookmark: pgfId-1951291]When you define a list-based host attribute, you must supply each of the values for the list. These values can contain alphanumeric characters, spaces, and symbols.
 
     [bookmark: pgfId-1988066]When you create a value for the host attribute, you can also auto-assign it to a block of IP addresses so that when a new host is discovered, it is automatically assigned a value for the host attribute.
 
     [bookmark: pgfId-2060193]To create a list-based host attribute:
 
     [bookmark: pgfId-2858093]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1951308]Step 1 [bookmark: 29403]To add a value to the list, click Add Value.
 
     [bookmark: pgfId-1988128]The List Values section expands.
 
     [bookmark: pgfId-1951311]Step 2 In the Name field, enter the first value you want to add, using alphanumeric characters, symbols, and spaces.
 
     [bookmark: pgfId-1988121]Step 3 [bookmark: 71302]Optionally, to auto-assign the attribute value you just added to your hosts, click Add Networks.
 
     [bookmark: pgfId-1988217]The Auto-Assign Networks section expands.
 
     [bookmark: pgfId-1951318]Step 4 [bookmark: 75930]Select the value you added from the Value drop-down list.
 
     [bookmark: pgfId-2719065]Step 5 [bookmark: 71466]In the IP Address and Netmask fields, enter the IP address and network mask (in CIDR notation) that represent the IP address block where you want to auto-assign this value.
 
     [bookmark: pgfId-2719008]For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1988251]Step 6 Repeat steps 1 through 5 to add additional values to the list and assign them automatically to new hosts that fall within an IP address block.
 
      
       
     
 
     
 
     [bookmark: pgfId-1952421]Tip If you do not want to auto-assign list values to the hosts in specific IP blocks, you can manually assign them as described in Working with the Predefined Host Attributes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3000537]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1879373][bookmark: 12396]Editing a User-Defined Host [bookmark: marker-2101209]Attribute
 
     [bookmark: pgfId-2834608]License: FireSIGHT
 
     [bookmark: pgfId-1879441]When you modify an existing user-defined host attribute, you can change the definition of a value, but you cannot change the attribute type (text, list, integer, URL). In addition, you cannot modify compliance white list host attributes.
 
     [bookmark: pgfId-1951153]To edit an existing user-defined host attribute:
 
     [bookmark: pgfId-2858109]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2857665]Step 1 Select Analysis > Hosts > Host Attributes.
 
     [bookmark: pgfId-2857666]The Host Attributes page appears.
 
     [bookmark: pgfId-2857667]Step 2 Click Host Attribute Management.
 
     [bookmark: pgfId-2857668]The Host Attribute Management page appears.
 ) next to the host attribute you want to edit. 
     
 
     [bookmark: pgfId-1951160]The host attribute page appears with the selected attribute’s settings.
 
     [bookmark: pgfId-1951164]Step 4 Modify any of the settings that you want and click Save.
 
     [bookmark: pgfId-1952611]See Creating User-Defined Host Attributes for more information about the attribute types that you can edit and the values those attributes can contain.
 
     [bookmark: pgfId-3000556]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1951434][bookmark: 43303]Deleting a User-Defined [bookmark: marker-2101238]Host Attribute
 
     [bookmark: pgfId-2834625]License: FireSIGHT
 
     [bookmark: pgfId-1988369]Delete a user-defined host attribute to remove it from every host profile where it is used. Note that you cannot delete compliance white list host attributes.
 
     [bookmark: pgfId-1951444]To delete a host attribute:
 
     [bookmark: pgfId-2858130]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2857945]Step 1 Select Analysis > Hosts > Host Attributes.
 
     [bookmark: pgfId-2857946]The Host Attributes page appears.
 
     [bookmark: pgfId-2857947]Step 2 Click Host Attribute Management.
 
     [bookmark: pgfId-2857948]The Host Attribute Management page appears.
 ) next to the host attribute you want to delete. 
     
 
     [bookmark: pgfId-1951441]The selected host attribute is removed from the system. 
 
     [bookmark: pgfId-3000568]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2176716][bookmark: 79588]Working w[bookmark: marker-2269149]ith Scan Results in a Host Profile
 
    [bookmark: pgfId-2756528]License: FireSIGHT
 
    [bookmark: pgfId-2317236]When you scan a host using Nmap, or when you import results from an Nmap scan, those results appear in the host profile for any hosts included in the scan.
 
    [bookmark: pgfId-2828275]The information that Nmap collects about the host operating system and any servers running on open unfiltered ports is added directly into the Operating System and Servers sections of the host profile, respectively. In addition, Nmap adds a list of the scan results for that host in the Scan Results section. 
 
    [bookmark: pgfId-2828267]Each result indicates the source of the information, the number and type of the scanned port, the name of the server running on the port, and any additional information detected by Nmap, such as the state of the port or the vendor name for the server. If you scan for UDP ports, servers detected on those ports only appear in the Scan Results section. 
 
    [bookmark: pgfId-2176877]Note that you can run an Nmap scan from the host profile. For more information, see the next section, Scanning a Host from the Host Profile.
 
     
      [bookmark: pgfId-2176775][bookmark: 12727]Scanning a Host fr[bookmark: marker-2375303]om the Host Profile
 
     [bookmark: pgfId-2834654]License: FireSIGHT
 
     [bookmark: pgfId-2828254]You can perform a Nmap scan against a host from the host profile. After the scan completes, server and operating system information for that host are updated in the host profile. Any additional scan results are added to the Scan Results section of the host profile.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2828248] 
      Caution Nmap-supplied server and operating system data remains static until you run another Nmap scan or override it with higher priority host input. If you plan to scan a host using Nmap, you may want to set up regularly scheduled scans to keep Nmap-supplied operating system and server data up to date. For more information, see 
      Automating Nmap Scans. 
       
       
 
      
 
     
 
     [bookmark: pgfId-2176794]To scan a host from the host profile:
 
     [bookmark: pgfId-2317995]Access: Admin
 
     
 
     [bookmark: pgfId-2176795]Step 1 In the host profile, click Scan Host.
 
     [bookmark: pgfId-2251728]The Scan Host pop-up window appears.
 
     [bookmark: pgfId-2251729]Step 2 Click Scan next to the scan remediation you want to use to scan the host.
 
     [bookmark: pgfId-2176796]The host is scanned and the results are added to the host profile.
 
     [bookmark: pgfId-3000580]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2154558]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2221292][bookmark: 59184]Working [bookmark: marker-2646284]with Discovery Events 
      
      
 
     
 
 
    [bookmark: pgfId-3533447]Discovery events alert you to the activity on your network and provide you with the information you need to respond appropriately. They are triggered by the changes that your managed devices detect in the network segments they monitor. Your network discovery policy specifies the kinds of data the system collects, the monitored network segments, and the specific hardware interfaces that your system uses to monitor traffic. For more information on network discovery, see Understanding Discovery Data Collection.
 
    [bookmark: pgfId-2296273]As a simple example of a discovery event, you may have conference rooms or spare work spaces where visiting employees attach to your network. You would expect to see New Host events generated on these segments on a regular basis, and you would not suspect malicious intent. However, if you see a New Host event on a network segment that is locked down, then you can escalate your response accordingly.
 
    [bookmark: pgfId-3586764]User discovery events provide information about users logged into the hosts on your network. You can view events that catalog user activity on the network and drill down to view information on a particular user. For example, if you want to see what user is associated with a new host, you can check the host profile to find out what users have been detected in traffic going to or from that host. 
 
    [bookmark: pgfId-3586765]Discovery events provide you with much greater depth of insight into the activity on your network and with much more granularity than this simple example shows. For each monitored host, you can configure the system to detect related application protocols, network protocols, clients, users, and potential vulnerabilities. The system can also provide information on vulnerabilities detected by third-party scanners that you import onto the Defense Center using the host input feature. Indications of compromise (IOC) use intrusion, malware, and other data to identify hosts whose security may be compromised. In addition, you can track any changes in host criticality, host attribute, or vulnerability settings that users enter via the user interface.
 
    [bookmark: pgfId-3450309]The system provides a set of predefined workflows that you can use to analyze the discovery events that your system generates. You can also create custom workflows that display only the information that matches your specific needs.
 
    [bookmark: pgfId-2376082]To collect and store network discovery data for analysis, make sure that your network discovery policy is configured to discover the appropriate data on the networks and zones where your Cisco-managed devices and NetFlow-enabled devices monitor traffic. To exclude monitored areas from discovery, configure that in the network discovery policy. Note that an access control policy must be applied to the managed device before you can apply a network discovery policy. For more information, see Creating a Network Discovery Policy.
 
    [bookmark: pgfId-2296653]For more information, see:
 
     
     	 [bookmark: pgfId-2296671]Viewing Discovery Event Statistics
 
     	 [bookmark: pgfId-3640898]Viewing Discovery Performance Graphs
 
     	 [bookmark: pgfId-2301570]Understanding Discovery Event Workflows
 
     	 [bookmark: pgfId-2296918]Working with Discovery and Host Input Events
 
     	 [bookmark: pgfId-2296947]Working with Hosts
 
     	 [bookmark: pgfId-2296965]Working with Host Attributes
 
     	 [bookmark: pgfId-3827098]Working with Indications of Compromise
 
     	 [bookmark: pgfId-2296970]Working with Servers
 
     	 [bookmark: pgfId-3613208]Working with Applications
 
     	 [bookmark: pgfId-2296985]Working with Application Details
 
     	 [bookmark: pgfId-2296990]Working with Vulnerabilities
 
     	 [bookmark: pgfId-3540310]Working with Third-Party Vulnerabilities
 
     	 [bookmark: pgfId-3575831]Working with Users
 
     	 [bookmark: pgfId-3575865]Working with User Activity
 
    
 
   
 
    
     [bookmark: pgfId-2296299][bookmark: 33807]Viewing Discovery [bookmark: marker-2647738]Event Statistics
 
    [bookmark: pgfId-3547902]License: FireSIGHT
 
    [bookmark: pgfId-2314220]The Discovery Statistics page displays a summary of the hosts, events, protocols, application protocols, and operating systems detected by the system:
 
     
     	 [bookmark: pgfId-3281679]The statistics summary provides general statistics about the total events, application protocols, hosts, network devices, and information about your host limit usage; see Statistics Summary.
 
     	 [bookmark: pgfId-3281684]The event breakdown provides statistics about the types of events occurring on the system; see Event Breakdown.
 
     	 [bookmark: pgfId-3281689]The protocol breakdown provides statistics about the protocols that detected hosts are using. See Protocol Breakdown.
 
     	 [bookmark: pgfId-3281694]The application protocol breakdown provides statistics about the application protocols running on the network; see Application Protocol Breakdown.
 
     	 [bookmark: pgfId-3281699]The operating system breakdown lists the operating systems that are running on the network and how many hosts are using each operating system; see OS Breakdown.
 
    
 
    [bookmark: pgfId-3280931]The page lists statistics for the last hour and the total accumulated statistics. You can select statistics for a particular device, or all devices. You can also view events that match the entries on the page by clicking the event, server, operating system, or operating system vendor listed within the summary.
 
    [bookmark: pgfId-2296311]To view the Discovery Statistics Summary:
 
    [bookmark: pgfId-3560624]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2296315]Step 1 Select Overview > Summary > Discovery Statistics.
 
    [bookmark: pgfId-2296319]The statistics summary page appears.
 
    [bookmark: pgfId-3531166]Step 2 From the Select Device list, select the device whose statistics you want to view. Select All to view statistics for all devices managed by the Defense Center.
 
    [bookmark: pgfId-3891591]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3531172][bookmark: 50813]Statistics [bookmark: marker-3531171]Summary
 
     [bookmark: pgfId-3547919]License: FireSIGHT
 
     [bookmark: pgfId-3224213]The statistics summary provides general statistics about the total events, application protocols, hosts, network devices, and information about your host limit usage.
 
     [bookmark: pgfId-2296371]Descriptions of the rows of the Statistics Summary section follow.
 
     [bookmark: pgfId-3756928]Total Events
 
     [bookmark: pgfId-3756929]Total number of discovery events stored on the Defense Center.
 
     [bookmark: pgfId-3756930]Total Events Last Hour
 
     [bookmark: pgfId-3756931]Total number of discovery events generated in the last hour.
 
     [bookmark: pgfId-3756932]Total Events Last Day
 
     [bookmark: pgfId-3757204]Total number of discovery events generated in the last day.
 
     [bookmark: pgfId-3756934]Total Application Protocols
 
     [bookmark: pgfId-3756935]Total number of application protocols from servers running on detected hosts.
 
     [bookmark: pgfId-3756936]Total IP Hosts
 
     [bookmark: pgfId-3757209]Total number of detected hosts identified by unique IP address.
 
     [bookmark: pgfId-3756938]Total MAC Hosts
 
     [bookmark: pgfId-3756939]Total number of detected hosts not identified by IP address.
 
     [bookmark: pgfId-3756940]Note that the Total MAC Hosts statistic remains the same whether you are viewing discovery statistics for all devices or for a specific device. This is so because managed devices discover hosts based on their IP addresses. This statistic gives the total of all hosts that are identified by other means and is independent of a given managed device.
 
     [bookmark: pgfId-3756941]Total Routers
 
     [bookmark: pgfId-3757215]Total number of detected nodes identified as routers.
 
     [bookmark: pgfId-3756943]Total Bridges
 
     [bookmark: pgfId-3756944]Total number of detected nodes identified as bridges.
 
     [bookmark: pgfId-3756945]Host Limit Usage
 
     [bookmark: pgfId-3756946]Total percentage of the host limit currently in use. The host limit is defined by your FireSIGHT license. Note that the host limit usage only appears if you are viewing statistics for all managed devices. For more information on monitoring host usage, see Configuring FireSIGHT Host Usage Monitoring.
 
      
       
     
 
     
 
     [bookmark: pgfId-3757218]Note If the host limit is reached and a host is deleted, the host will not reappear on the network map until you restart network discovery on all managed devices configured to perform discovery.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3757219]Last Event Received
 
     [bookmark: pgfId-3757220]The date and time that the most recent discovery event occurred.
 
     [bookmark: pgfId-3756950]Last Connection Received
 
     [bookmark: pgfId-3756951]The date and time that the most recent connection was completed.
 
    
 
     
      [bookmark: pgfId-2296489][bookmark: 48920]Event Breakd[bookmark: marker-2644821]own
 
     [bookmark: pgfId-3547944]License: FireSIGHT
 
     [bookmark: pgfId-3416255]The Event Breakdown section lists a count of each type of network discovery and host input event that occurred within the last hour, as well as a count of the total number of each event type stored in the database. For full descriptions of each event type, see Understanding Discovery Event Types and Understanding Host Input Event Types.
 
     [bookmark: pgfId-2331019]You can also use the Event Breakdown section to view details on discovery and host input events.
 
     [bookmark: pgfId-2331023]To view network discovery and host input events by type:
 
     [bookmark: pgfId-3560638]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2331024]Step 1 Click the type of event you want to view.
 
     [bookmark: pgfId-2949701]The first page of the default discovery events workflow appears, constrained by the event type you picked. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
     [bookmark: pgfId-2949306]For information on working with discovery events, see Working with Discovery and Host Input Events.
 
     [bookmark: pgfId-3891729]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2296536][bookmark: 52850]Pro[bookmark: marker-2644841]tocol Breakdown
 
     [bookmark: pgfId-3547973]License: FireSIGHT
 
     [bookmark: pgfId-2296538]The Protocol Breakdown section lists the protocols currently in use by detected hosts. It displays each detected protocol name, its “layer” in the protocol stack, and the total number of hosts that communicate using the protocol.
 
    
 
     
      [bookmark: pgfId-3583872][bookmark: 68082][bookmark: marker-3583871]Application Protocol Br[bookmark: marker-3785643]eakdown
 
     [bookmark: pgfId-3583876]License: FireSIGHT
 
     [bookmark: pgfId-2296564]The Application Protocol Breakdown section lists the application protocols that are currently in use by detected hosts. It lists the protocol name, the total number of hosts running the application protocol in the past hour, and the total number of hosts that have been detected running the protocol at any point.
 
     [bookmark: pgfId-2917487]You can also use the Application Protocol Breakdown section to view details on servers using the detected protocols.
 
     [bookmark: pgfId-2917491]To view servers that use a listed application protocol:
 
     [bookmark: pgfId-3560668]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2917492]Step 1 Click the name of the application protocol you want to view.
 
     [bookmark: pgfId-2950052]The first page of the default servers workflow appears, constrained by the application protocol you picked. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings.
 
     [bookmark: pgfId-2389003]For information on working with servers, see Working with Servers.
 
     [bookmark: pgfId-3891752]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2296594][bookmark: 86084]OS B[bookmark: marker-2635342]reakdown
 
     [bookmark: pgfId-3548022]License: FireSIGHT
 
     [bookmark: pgfId-2296596]The OS Breakdown section lists the operating systems currently running on the monitored network, along with their vendors and the total number of hosts running each operating system.
 
     [bookmark: pgfId-3253796]A value of unknown for the operating system name or version means that the operating system or its version does not match any of the system’s fingerprints. A value of pending means that the system has not yet gathered enough information to identify the operating system or its version.
 
     [bookmark: pgfId-2332289]You can use the OS Breakdown section to view details on the detected operating systems.
 
     [bookmark: pgfId-2296597]To view hosts by operating system or vendor:
 
     [bookmark: pgfId-3560682]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2296598]Step 1 You have two options:
 
      
       
       	 [bookmark: pgfId-2332364]To view all hosts running a specific operating system, under  OS Name , click the operating system name.
 
       	 [bookmark: pgfId-2332352]To view all hosts running any operating system from a specific vendor, under  OS Vendor , click the vendor name.
 
      
 
     
 
     [bookmark: pgfId-2950863]The first page of the default hosts workflow appears, constrained by the operating system or vendor you picked. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings.
 
     [bookmark: pgfId-2389153]For information on working with hosts, see Working with Hosts.
 
     [bookmark: pgfId-3891768]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3640563][bookmark: 20026]Viewing Discovery Perf[bookmark: marker-3640562]ormance Graphs
 
    [bookmark: pgfId-3640567]License: FireSIGHT
 
    [bookmark: pgfId-3640568]You can generate graphs that display performance statistics for managed devices with discovery events.
 
     
      
    
 
    
 
    [bookmark: pgfId-3640569]Note New data is accumulated for statistics graphs every five minutes. Therefore, if you reload a graph quickly, the data may not change until the next five-minute increment occurs.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3640573]Descriptions of the available graph types follow.
 
    [bookmark: pgfId-3758033]Processed Events/Sec
 
    [bookmark: pgfId-3758034]Displays a graph that represents the number of events that the Data Correlator processes per second
 
    [bookmark: pgfId-3758035]Processed Connections/Sec
 
    [bookmark: pgfId-3758903]Displays a graph that represents the number of connections that the Data Correlator processes per second
 
    [bookmark: pgfId-3758904]Generated Events/Sec
 
    [bookmark: pgfId-3758905]Displays a graph that represents the number of events that the system generates per second
 
    [bookmark: pgfId-3758039]Mbits/Sec
 
    [bookmark: pgfId-3758040]Displays a graph that represents the number of megabits of traffic that are analyzed by the discovery process per second
 
    [bookmark: pgfId-3758041]Avg Bytes/Packet
 
    [bookmark: pgfId-3758042]Displays a graph that represents the average number of bytes included in each packet analyzed by the discovery process
 
    [bookmark: pgfId-3758043]K Packets/Sec
 
    [bookmark: pgfId-3758044]Displays a graph that represents the number of packets analyzed by the discovery process per second, in thousands
 
    [bookmark: pgfId-3640612]To generate discovery performance graphs:
 
    [bookmark: pgfId-3640613]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3640614]Step 1 Select Overview > Summary > Discovery Performance. 
 
    [bookmark: pgfId-3640615]The Discovery Performance page appears.
 
    [bookmark: pgfId-3640623]Step 2 From the Select Device list, select the Defense Center or managed devices you want to include.
 
    [bookmark: pgfId-3640624]Depending on which appliance you select, the Select Graph(s) list adjusts to display the available graphs.
 
    [bookmark: pgfId-3640625]Step 3 From the Select Graph(s) list, select the type of graph you want to create. 
 
     
      
    
 
    
 
    [bookmark: pgfId-3640626]Tip You can select multiple graphs by holding down the Ctrl or Shift keys while clicking on the graph type.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3640627]Step 4 From the Select Time Range list, select the time range you would like to use for the graph. You can choose from last hour, last day, last week, or last month.
 
    [bookmark: pgfId-3668320]Step 5 Click Graph to graph the selected statistics.
 
    [bookmark: pgfId-3668411]The selected graph appears.
 
    [bookmark: pgfId-3891787]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2300257][bookmark: 36547]Understanding Discovery Event [bookmark: marker-2650055]Workflows
 
    [bookmark: pgfId-3548039]License: FireSIGHT
 
    [bookmark: pgfId-2318720]The Defense Center provides a set of workflows that you can use to analyze the discovery events that are generated for your network. The workflows are, along with the network map, a key source of information about your network assets. These workflows contain tables that are populated with discovery data generated by the system.
 
    [bookmark: pgfId-2319136]Access network discovery workflows from the Analysis > Hosts menu. The Defense Center provides predefined workflows for discovery events, as well as for detected hosts and their host attributes, servers, applications, application details, vulnerabilities, user activities, and users. You can also create custom workflows. For more information on workflows, see Understanding and Using Workflows.
 
     
      
    
 
    
 
    [bookmark: pgfId-3734096]Tip Select Analysis > Custom > Custom Tables to access workflows based on custom tables.
 
     
     
 
    
 
    
 
     
     Working with Indications of Compromise 
     
 
     Understanding User Details and Host History 
     
 
     
 
      
       
       [bookmark: pgfId-2390891]Table 50-1 [bookmark: 29243]Common Discovery Event Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-2390895]To... 
         
  
        	 
          
          [bookmark: pgfId-2390897]You can... 
         
  
       
 
        
        	[bookmark: pgfId-2390899]view the host profile for an IP address
  ) that appears next to the IP address. For information on IOC, see . 
       
 
        
        	[bookmark: pgfId-2947356]view user profile information
  ) that appears next to the user identity. For more information, see . 
       
 
        
        	[bookmark: pgfId-3298017]sort data
  
        	[bookmark: pgfId-3298019]click the column title. Click the column title again to reverse the sort order.
  
       
 
        
        	[bookmark: pgfId-3751703]drill down to the next page in the workflow
  
        	[bookmark: pgfId-3751705]use one of the following methods:
 
          
          	 [bookmark: pgfId-3751706]To drill down to the next workflow page constraining on a specific value, click  a value within a row. Note that this only works on drill-down pages. Clicking a value within a row in a table view only constrains the table view and does not drill down to the next page.
 
          	 [bookmark: pgfId-3751707]To drill down to the next workflow page constraining on some events, select the check boxes next to the events you want to view on the next workflow page, then click  View .
 
          	 [bookmark: pgfId-3751708]To drill down to the next workflow page keeping the current constraints, click  View All .
 
         
 [bookmark: pgfId-3751709]Tip Table views always include “Table View” in the page name. [bookmark: pgfId-3751713]For more information, see Constraining Events.
  
       
 
        
        	[bookmark: pgfId-3298021]constrain the columns that appear
  . . To add a disabled column back to the view, click the expand arrow to expand the search constraints, then click the column name under Disabled Columns. 
       
 
        
        	[bookmark: pgfId-2390910]navigate within the current workflow page
  
        	[bookmark: pgfId-2390914]find more information in Navigating to Other Pages in the Workflow.
  
       
 
        
        	[bookmark: pgfId-2390917]navigate between pages in the current workflow, keeping the current constraints
  
        	[bookmark: pgfId-2390919]click the appropriate page link at the top left of the workflow page. For more information, see Using Workflow Pages.
  
       
 
        
        	[bookmark: pgfId-2390924]delete items from the system, including:
 
          
          	 [bookmark: pgfId-2390928]discovery and host input events from discovery event workflows
 
          	 [bookmark: pgfId-2390929]hosts and network devices from host workflows
 
          	 [bookmark: pgfId-2390930]host attributes from host attribute workflows
 
          	 [bookmark: pgfId-2390931]servers from server workflows
 
          	 [bookmark: pgfId-2390932]applications from application workflows
 
          	 [bookmark: pgfId-3443578]third-party vulnerabilities from third-party vulnerability workflows
 
          	 [bookmark: pgfId-3591373]users from user workflows
 
         
  
        	[bookmark: pgfId-2390934]use one of the following methods:
 
          
          	 [bookmark: pgfId-2390935]To delete some items, select the check boxes next to items you want to delete, then click  Delete .
 
          	 [bookmark: pgfId-2390936]To delete all items in the current constrained view, click  Delete All , then confirm you want to delete all the items.
 
         
 [bookmark: pgfId-3443613]These items remain deleted until the system’s discovery function is restarted, when they may be detected again.
 [bookmark: pgfId-3443631]Tip See Purging Discovery Data from the Database for information on deleting all discovery events from the database and also for information on how to restart discovery. [bookmark: pgfId-3443571]Note that you cannot delete Cisco (as opposed to third-party) vulnerabilities; you can, however, mark them reviewed. For more information, see Working with Vulnerabilities.
  
       
 
        
        	[bookmark: pgfId-2390961]navigate to other event views to view associated events
  
        	[bookmark: pgfId-2390966]find more information in Navigating Between Workflows.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-2391012][bookmark: 19896]Working with[bookmark: marker-2650057] Discovery and Host Input Events
 
    [bookmark: pgfId-3548055]License: FireSIGHT
 
    [bookmark: pgfId-2391001]The system generates discovery events that communicate the details of changes in your monitored network segments. New events are generated for newly discovered network features, and change events are generated for any change in previously identified network assets.
 
    [bookmark: pgfId-3591619]During its initial network discovery phase, the system generates new events for each host and any TCP or UDP servers discovered running on each host. Optionally, you can configure the system to use data exported by NetFlow-enabled devices to generate these new host and server events.
 
    [bookmark: pgfId-3591620]In addition, the system generates new events for each network, transport, and application protocol running on each discovered host. When you create a discovery rule configured to include NetFlow-enabled devices, you can disable detection of application protocols. However, you cannot disable application detection in discovery rules that do not use a configured NetFlow-enabled device. If you enable host or user discovery in non-NetFlow discovery rules, applications are automatically discovered.
 
    [bookmark: pgfId-2606927]After the initial network mapping is complete, the system continuously records network changes by generating change events. Change events are generated whenever the configuration of a previously discovered asset changes.
 
    [bookmark: pgfId-2390186]When a discovery event is generated, it is logged to the database. You can use the Defense Center web interface to view, search, and delete discovery events.You can also use discovery events in correlation rules. Based on the type of discovery event generated as well as other criteria that you specify, you can build correlation rules that, when used in a correlation policy, launch remediations and syslog, SNMP, and email alert responses when network traffic meets your criteria.
 
    [bookmark: pgfId-2797980]You can add data to the network map using the host input feature. You can add, modify, or delete operating system information, which causes the system to stop updating that information for that host. You can also manually add, modify, or delete application protocols, clients, servers, and host attributes or modify vulnerability information. When you do this, the system generates host input events.
 
    [bookmark: pgfId-2304271]See the following sections for more information:
 
     
     	 [bookmark: pgfId-2302483]Understanding Discovery Event Types
 
     	 [bookmark: pgfId-2777605]Understanding Host Input Event Types
 
     	 [bookmark: pgfId-2302512]Viewing Discovery and Host Input Events
 
     	 [bookmark: pgfId-2554375]Understanding the Discovery Events Table
 
     	 [bookmark: pgfId-2302541]Searching for Discovery Events
 
    
 
     
      [bookmark: pgfId-2299709][bookmark: 23727]Understanding Discovery E[bookmark: marker-3654011]vent Types
 
     [bookmark: pgfId-3548071]License: FireSIGHT
 
     [bookmark: pgfId-2839532]There are many types of discovery events. For example, the system generates and logs a New Host event when it detects a new host on your monitored network segment. When you view a table of discovery events, the event type is listed in the Event column. For more information, see Viewing Discovery and Host Input Events.
 
     [bookmark: pgfId-2839545]Contrast discovery events, which are generated when the system detects a change in your monitored network (such as detecting traffic from a previously undetected host), with host input events, which are generated when a user takes a specific action (such as manually adding a host). For more information on host input events, see Understanding Host Input Event Types.
 
     [bookmark: pgfId-2304350]You can configure the types of discovery events the system logs by modifying your network discovery policy. By default, the system logs all types of discovery events. For more information, see Configuring Database Event Limits.
 
     [bookmark: pgfId-3413319]If you understand the information the different types of discovery events provide, you can more effectively determine which events you want to log and alert on, and how to use these alerts in correlation policies. In addition, knowing the names of the event types can help you craft more effective event searches. Descriptions of the different types of[bookmark: marker-3416297] discovery events follow.
 
     [bookmark: pgfId-3759855][bookmark: marker-3759854]Additional MAC Detected for Host
 
     [bookmark: pgfId-3759857]This event is generated when the system detects a new MAC address for a previously discovered host.
 
     [bookmark: pgfId-3759858]This event is often generated when the system detects hosts passing traffic through a router. While each host has a different IP address, they all appear to have the MAC address associated with the router. When the system detects the actual MAC address associated with the IP address, it displays the MAC address in bold text within the host profile and displays an “ARP/DHCP detected” message within the event description in the event view.
 
     [bookmark: pgfId-3759861][bookmark: marker-3759860]Client Timeout
 
     [bookmark: pgfId-3759863]This event is generated when the system drops a client from the database due to inactivity.
 
     [bookmark: pgfId-3759866][bookmark: marker-3759865]Client Update
 
     [bookmark: pgfId-3759869]This e[bookmark: marker-3759868]vent is generated when the system detects a payload (that is, a specific type of content, such as audio, video, or webmail) in HTTP traffic.
 
     [bookmark: pgfId-3759872][bookmark: marker-3759871]DHCP: IP Address Changed
 
     [bookmark: pgfId-3759874]This event is generated when the system detects that a host IP address has changed due to DHCP address assignment.
 
     [bookmark: pgfId-3759877][bookmark: marker-3759876]DHCP: IP Address Reassigned
 
     [bookmark: pgfId-3759879]This event is generated when a host is reusing an IP address; that is, when a host obtains an IP address formerly used by another physical host due to DHCP IP address assignment.
 
     [bookmark: pgfId-3759882][bookmark: marker-3759881]Hops Change
 
     [bookmark: pgfId-3759884]This event is generated when the system detects a change in the number of network hops between a host and the device that detects the host.
 
     [bookmark: pgfId-3759885]This may happen if the device sees host traffic through different routers and is able to make a better determination of the host’s location. This may also happen if the device detects an ARP transmission from the host, indicating that the host is on a local segment.
 
     [bookmark: pgfId-3759888][bookmark: marker-3759887]Host Deleted: Host Limit Reached
 
     [bookmark: pgfId-3759893]This event is generated when the host limit on the Defense Center is exceeded and a monitored host is deleted from the Defense Center’s network map.
 
     [bookmark: pgfId-3759903][bookmark: marker-3759902]Host Dropped: Host Limit Reached
 
     [bookmark: pgfId-3759908]This event is generated when the host limit on the Defense Center is reached and a new host is dropped. Compare this with the previous event where old hosts are deleted from the network map when the host limit is reached. 
 
     [bookmark: pgfId-3759909]To drop new hosts when the host limit is reached, go to Policies > Network Discovery > Advanced and set When Host Limit Reached to Drop hosts. See Configuring Data Storage for more information.
 
     [bookmark: pgfId-3893979]Host IOC Set
 
     [bookmark: pgfId-3893987]This event is generated when an IOC (Indications of Compromise) is set for a host and generates an alert.
 
     [bookmark: pgfId-3759915][bookmark: marker-3759914]Host Timeout
 
     [bookmark: pgfId-3759918][bookmark: MyTest]This event is generated when a host is dropped from the network map because the host has not produced traffic within the interval defined in the network discovery policy. Note that individual host IP addresses and MAC addresses time out individually; a host does not disappear from the network map unless all of its associated addresses have timed out. See Configuring Data Storage for information about configuring the host timeout value.
 
     [bookmark: pgfId-3759922]If you change the networks you want to monitor in your network discovery policy, you may want to manually delete old hosts from the network map so that they do not count against your FireSIGHT license. For more information, see Working with the Hosts Network Map.
 
     [bookmark: pgfId-3759931][bookmark: marker-3759930]Host Type Changed to Network Device
 
     [bookmark: pgfId-3759933]This event is generated when the system detects that a detected host is actually a network device.
 
     [bookmark: pgfId-3759936][bookmark: marker-3759935]Identity Conflict
 
     [bookmark: pgfId-3759938]This event is generated when the system detects a new server or operating system identity that conflicts with a current active identity for that server or operating system. 
 
     [bookmark: pgfId-3759939]If you want to resolve identity conflicts by rescanning the host to obtain newer active identity data, you can use Identity Conflict events to trigger an Nmap remediation. For more information, see Configuring Nmap Remediations.
 
     [bookmark: pgfId-3759946]For more information, see Understanding Identity Conflicts and Configuring Identity Conflict Resolution. For information on manually resolving conflicts, see Resolving Operating System Identity Conflicts and Resolving Server Identity Conflicts.
 
     [bookmark: pgfId-3759958][bookmark: marker-3759957]Identity Timeout
 
     [bookmark: pgfId-3759960]This event is generated when identity data that was added to the network map through an active source times out. 
 
     [bookmark: pgfId-3759961]If you want to refresh identity data by rescanning the host to obtain newer active identity data, you can use Identity Conflict events to trigger an Nmap remediation. For more information, see Configuring Nmap Remediations.
 
     [bookmark: pgfId-3759968]For more information, see Resolving Server Identity Conflicts.
 
     [bookmark: pgfId-3759971][bookmark: marker-3759970]MAC Information Change
 
     [bookmark: pgfId-3759973]This event is generated when the system detects a change in the information associated with a specific MAC address or TTL value.
 
     [bookmark: pgfId-3759974]This event often occurs when the system detects hosts passing traffic through a router. While each host has a different IP address, they will all appear to have the MAC address associated with the router. When the system detects the actual MAC address associated with the IP address, it displays the MAC address in bold text within the host profile and displays an “ARP/DHCP detected” message within the event description in the event view. The TTL may change because the traffic may pass through different routers or if the system detects the actual MAC address of the host.
 
     [bookmark: pgfId-3759977][bookmark: marker-3759976]NETBIOS Name Change
 
     [bookmark: pgfId-3759979]This event is generated when the system detects a change to a host’s NetBIOS name. This event will only be generated for hosts using the NetBIOS protocol. 
 
     [bookmark: pgfId-3759982][bookmark: marker-3759981]New Client
 
     [bookmark: pgfId-3759984]This event is generated when the system detects a new client. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3759985]Note To collect and store client data for analysis, make sure that you enable application detection in your discovery rules in the network discovery policy. For more information, see Understanding Application Detection.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3759991][bookmark: marker-3759990]New Host
 
     [bookmark: pgfId-3759993]This event is generated when the system detects a new host running on the network. 
 
     [bookmark: pgfId-3759994]If you select the Discover option and select Hosts in a network discovery rule where a NetFlow device is selected, this event is also generated when a device processes NetFlow data that involves a new host.
 
     [bookmark: pgfId-3759997][bookmark: marker-3759996]New Network Protocol
 
     [bookmark: pgfId-3759999]This event is generated when the system detects that a host is communicating with a new network protocol (IP, ARP, and so on).
 
     [bookmark: pgfId-3760002][bookmark: marker-3760001]New OS
 
     [bookmark: pgfId-3760004]This event is generated when the system either detects a new operating system for a host, or a change in a host’s operating system.
 
     [bookmark: pgfId-3760007][bookmark: marker-3760006]New TCP Port
 
     [bookmark: pgfId-3760009]This event is generated when the system detects a new TCP server port (for example, a port used by SMTP or web services) active on a host. Note that this event is not used to identify the application protocol or the server associated with it; that information is transmitted in the TCP Server Information Update event.
 
     [bookmark: pgfId-3760010]If you select the Discover option and select Applications in a network discovery rule for NetFlow data, this event is also generated when a device processes NetFlow data involving a server on your monitored networks that does not already exist in the network map.
 
     [bookmark: pgfId-3760013][bookmark: marker-3760012]New Transport Protocol
 
     [bookmark: pgfId-3760015]This event is generated when the system detects that a host is communicating with a new transport protocol, such as TCP or UDP.
 
     [bookmark: pgfId-3760018][bookmark: marker-3760017]New UDP Port
 
     [bookmark: pgfId-3760020]This event is generated when the system detects a new UDP server port running on a host. 
 
     [bookmark: pgfId-3760021]If you select the Discover option and select Applications in a network discovery rule for NetFlow data, this event is also generated when a device processes NetFlow data involving a server on your monitored networks that does not already exist in the network map.
 
     [bookmark: pgfId-3760024][bookmark: marker-3760023]TCP Port Closed
 
     [bookmark: pgfId-3760026]This event is generated when the system detects that a TCP port has closed on a host.
 
     [bookmark: pgfId-3760029][bookmark: marker-3760028]TCP Port Timeout
 
     [bookmark: pgfId-3760031]This event is generated when the system has not detected activity from a TCP port within the interval defined in the system’s network discovery policy. See Configuring Data Storage for information about configuring the server timeout value.
 
     [bookmark: pgfId-3760042][bookmark: marker-3760036][bookmark: marker-3760041]TCP Server Information Update
 
     [bookmark: pgfId-3760044]This event is generated when the system detects a change in a discovered TCP server running on a host.
 
     [bookmark: pgfId-3760045]This event may be generated if a TCP server is upgraded.
 
     [bookmark: pgfId-3760048][bookmark: marker-3760047]UDP Port Closed
 
     [bookmark: pgfId-3760050]This event is generated when the system detects that a UDP port has closed on a host.
 
     [bookmark: pgfId-3760053][bookmark: marker-3760052]UDP Port Timeout
 
     [bookmark: pgfId-3760055]This event is generated when the system has not detected activity from a UDP port within the interval defined in the network discovery policy. See Configuring Data Storage for information about configuring the server timeout value.
 
     [bookmark: pgfId-3760066][bookmark: marker-3760060][bookmark: marker-3760065]UDP Server Information Update
 
     [bookmark: pgfId-3760068]This event is generated when the system detects a change in a discovered UDP server running on a host.
 
     [bookmark: pgfId-3760069]This event may be generated if a UDP server is upgraded.
 
     [bookmark: pgfId-3785711][bookmark: marker-3785709]VLAN Tag Information Update
 
     [bookmark: pgfId-3785712]This event is generated when the system detects a change in the VLAN tag attributed to a host. For more information about VLAN tags, see Working with VLAN Tags in the Host Profile.
 
    
 
     
      [bookmark: pgfId-2392063][bookmark: 79962]Understanding Host Inp[bookmark: marker-2869037]ut Event Types
 
     [bookmark: pgfId-3548087]License: FireSIGHT
 
     [bookmark: pgfId-2839309]There are many types of host input events. For example, the system generates and logs an Add Host event when a user adds a host using the host import feature. When you view a table of discovery events, the event type is listed in the Event column. For more information, see Viewing Discovery and Host Input Events.
 
     [bookmark: pgfId-2839557]Contrast host input events, which are generated when a user takes a specific action (such as manually adding a host), with discovery events, which are generated when the system itself detects a change in your monitored network (such as detecting traffic from a previously undetected host). For more information on host input events, see Understanding Discovery Event Types.
 
     [bookmark: pgfId-2839319]You can configure the types of host input events that the system logs by modifying your network discovery policy. By default, the system logs all types of host input events. For more information, see Configuring Database Event Limits.
 
     [bookmark: pgfId-2839332]If you understand the information the different types of host input events provide, you can more effectively determine which events you want to log and alert on, and how to use these alerts in correlation policies. In addition, knowing the names of the event types can help you craft more effective event searches. Descriptions of the different types of[bookmark: marker-2839336] host input events follow.
 
     [bookmark: pgfId-3760472][bookmark: marker-3760471]Add Client
 
     [bookmark: pgfId-3760474]This event is generated when a user adds a client. 
 
     [bookmark: pgfId-3760477][bookmark: marker-3760476]Add Host
 
     [bookmark: pgfId-3760479]This event is generated when a user adds a host.
 
     [bookmark: pgfId-3760482][bookmark: marker-3760481]Add Protocol
 
     [bookmark: pgfId-3760484]This event is generated when a user adds a protocol.
 
     [bookmark: pgfId-3760487][bookmark: marker-3760486]Add Scan Result
 
     [bookmark: pgfId-3760489]This event is generated when the system adds the results of an Nmap scan to a host.
 
     [bookmark: pgfId-3760491]Add Port
 
     [bookmark: pgfId-3760493]This event is generated when a user adds a server port.
 
     [bookmark: pgfId-3760496][bookmark: marker-3760495]Delete Client
 
     [bookmark: pgfId-3760498]This event is generated when a user deletes a client from the system.
 
     [bookmark: pgfId-3760501][bookmark: marker-3760500]Delete Host/Network
 
     [bookmark: pgfId-3760503]This event is generated when a user deletes an IP address or subnet from the system.
 
     [bookmark: pgfId-3760506][bookmark: marker-3760505]Delete Protocol
 
     [bookmark: pgfId-3760508]This event is generated when a user deletes a protocol from the system.
 
     [bookmark: pgfId-3760511][bookmark: marker-3760510]Delete Port
 
     [bookmark: pgfId-3760513]This event is generated when a user deletes a server port or group of server ports from the system.
 
     [bookmark: pgfId-3760516][bookmark: marker-3760515]Host Attribute Add
 
     [bookmark: pgfId-3760518]This event is generated when a user creates a new host attribute.
 
     [bookmark: pgfId-3760521][bookmark: marker-3760520]Host Attribute Delete
 
     [bookmark: pgfId-3760523]This event is generated when a user deletes a user-defined host attribute. 
 
     [bookmark: pgfId-3760526][bookmark: marker-3760525]Host Attribute Delete Value
 
     [bookmark: pgfId-3760528]This event is generated when a user deletes a value assigned to a host attribute. 
 
     [bookmark: pgfId-3760531][bookmark: marker-3760530]Host Attribute Set Value
 
     [bookmark: pgfId-3760533]This event is generated when a user sets a host attribute value for a host. 
 
     [bookmark: pgfId-3760536][bookmark: marker-3760535]Host Attribute Update
 
     [bookmark: pgfId-3760538]This event is generated when a user changes the definition of a user-defined host attribute.
 
     [bookmark: pgfId-3760541][bookmark: marker-3760540]Set Host Criticality
 
     [bookmark: pgfId-3760543]This event is generated when a user sets or modifies the host criticality value for a host. 
 
     [bookmark: pgfId-3760546][bookmark: marker-3760545]Set Operating System Definition
 
     [bookmark: pgfId-3760548]This event is generated when a user sets the operating system for a host.
 
     [bookmark: pgfId-3760551][bookmark: marker-3760550]Set Server Definition
 
     [bookmark: pgfId-3760553]This event is generated when a user sets the vendor and version definitions for a server. 
 
     [bookmark: pgfId-3760556][bookmark: marker-3760555]Set Vulnerability Impact Qualification
 
     [bookmark: pgfId-3760558]This event is generated when a vulnerability impact qualification is set. 
 
     [bookmark: pgfId-3760559]When a vulnerability is disabled at a global level from being used for impact qualifications, or when a vulnerability is enabled at a global level, this event is generated.
 
     [bookmark: pgfId-3760562][bookmark: marker-3760561]Vulnerability Set Invalid
 
     [bookmark: pgfId-3760564]This event is generated when a user invalidates (or reviews) a vulnerability or vulnerabilities.
 
     [bookmark: pgfId-3760567][bookmark: marker-3760566]Vulnerability Set Valid
 
     [bookmark: pgfId-3760569]This event is generated when a user validates a vulnerability that was previously marked as invalid.
 
    
 
     
      [bookmark: pgfId-2847766][bookmark: 97481]Viewing[bookmark: marker-2839292] Discovery and Host Input Events
 
     [bookmark: pgfId-3548103]License: FireSIGHT
 
     [bookmark: pgfId-3538887]Both discovery events and host input events can be viewed using Discovery Events workflows. Discovery events record the detection of network discovery data based on the configured network discovery policy for an appliance. Host input events record the input of host data into the network map through the host input feature. For more information, see Understanding Discovery Event Types and Understanding Host Input Event Types. 
 
     [bookmark: pgfId-3616800]You can use the Defense Center to view a table of discovery or host input events. Then, you can manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-2304707]The page you see when you access events differs depending on the workflow you use. You can use the predefined workflow, which includes the table view of discovery events and a terminating host view page. You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
     [bookmark: pgfId-2389838]The Discovery Event Actions table below describes some of the specific actions you can perform on a discovery events workflow page. You can also perform the tasks described in the Common Discovery Event Actions table.
 
     [bookmark: pgfId-2301462]
 
      
       
        
        [bookmark: pgfId-2334432]Table 50-2 [bookmark: 66807]Discovery Event Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-2334436]To... 
          
  
         	 
           
           [bookmark: pgfId-2334438]You can... 
          
  
        
 
         
         	[bookmark: pgfId-2334461]modify the time and date range for displayed events
  
         	[bookmark: pgfId-2334466]find more information in Setting Event Time Constraints.
 [bookmark: pgfId-2999228]Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.
  
        
 
         
         	[bookmark: pgfId-2334440]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-2334444]find more information in Understanding the Discovery Events Table.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2299835]To view discovery events:
 
     [bookmark: pgfId-3560695]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2299839]Step 1 Select Analysis > Hosts > Discovery Events.
 
     [bookmark: pgfId-2951350]The first page of the default discovery events workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
    
 
     
      [bookmark: pgfId-2500397][bookmark: 22261]Understanding the[bookmark: marker-2650192] Discovery Events Table
 
     [bookmark: pgfId-3548127]License: FireSIGHT
 
     [bookmark: pgfId-3540877]The system generates discovery events that communicate the details of changes in your monitored network segments. New events are generated for newly discovered network features, and change events are generated for any change in previously identified network assets.
 
     [bookmark: pgfId-2500408]During its initial network discovery phase, the system generates new events for each host and any TCP or UDP servers it discovers on each host. In addition, the system generates new events for each network, transport, or application protocol running on each discovered host. For NetFlow-related traffic, you can control whether the system generates new events when it detects application protocols running on a host. After the initial network mapping is complete, the system continuously records network changes by generating change events. Change events are generated whenever the configuration of a previously discovered host, server, or client changes.
 
     [bookmark: pgfId-2500421]Descriptions of the fields in the discovery events table follow.
 
     [bookmark: pgfId-3760859]Time
 
     [bookmark: pgfId-3760861]The time that the system generated the event.
 
     [bookmark: pgfId-3760863]Event
 
     [bookmark: pgfId-3760868]The event type. See Understanding Discovery Event Types and Understanding Host Input Event Types for a description of each available event.
 
     [bookmark: pgfId-3760873]IP Address
 
     [bookmark: pgfId-3760875]The IP address associated with the host involved in the event.
 
     [bookmark: pgfId-3760877]User
 
     [bookmark: pgfId-3760879]The last user to log into the host involved in the event before the event was generated. If only non-authoritative users log in after an authoritative user, the authoritative user remains the current user for the host unless another authoritative user logs in.
 
     [bookmark: pgfId-3760881]MAC Address
 
     [bookmark: pgfId-3760883]The MAC address of the NIC used by the network traffic that triggered the discovery event. This MAC address can be either the actual MAC address of the host involved in the event, or the MAC address of a network device that the traffic passed through.
 
     [bookmark: pgfId-3760885]MAC Vendor
 
     [bookmark: pgfId-3760887]The MAC hardware vendor of the NIC used by the network traffic that triggered the discovery event.
 
     [bookmark: pgfId-3760889]Port
 
     [bookmark: pgfId-3760891]The port used by the traffic that triggered the event, if applicable.
 
     [bookmark: pgfId-3760893]Description
 
     [bookmark: pgfId-3760895]The text description of the event.
 
     [bookmark: pgfId-3760909]Device
 
     [bookmark: pgfId-3760911]The name of the device that generated the event. For new host and new server events based on NetFlow data, this is the device that processed the NetFlow data.
 
    
 
     
      [bookmark: pgfId-3742328][bookmark: 55400]Searching for [bookmark: marker-3742326]Discovery Events
 
     [bookmark: pgfId-3893880]License: FireSIGHT
 
     [bookmark: pgfId-3893881]You can search for specific discovery events. You may want to create searches customized for your network environment, then save them to reuse later. 
 
     [bookmark: pgfId-3742336][bookmark: 15132]General Search Syntax
 
     [bookmark: pgfId-3742337]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3742338]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3929703]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3929704]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3929705] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3929706] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3929707] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3929708]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3742340]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3742341]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3742342]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3742343]IP addresses may be specified using CIDR notation.
 
      	 [bookmark: pgfId-3947256]Use the device field to search for specific devices as well as devices in groups, stacks, or clusters. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
      	 [bookmark: pgfId-3742347]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3742348]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3742353][bookmark: 72965]Special Search Syntax for Discovery Events
 
      
       
        
        [bookmark: pgfId-3742364]Table 50-3 [bookmark: 76691]Discovery Event Search Criteria Notes 
 
        
        
         
         	 
           
           [bookmark: pgfId-3742368]Field 
          
  
         	 
           
           [bookmark: pgfId-3742370]Search Criteria Notes 
          
  
        
 
         
         	[bookmark: pgfId-3742372]Event
  
         	[bookmark: pgfId-3742376]The range of event names is listed in Understanding Discovery Event Types and Understanding Host Input Event Types
  
        
 
         
         	[bookmark: pgfId-3742382]MAC Vendor
  
         	[bookmark: pgfId-3742384]To search for virtual MAC vendors, that is, for events that involve virtual machines, type virtual_mac_vendor.
 [bookmark: pgfId-3742385]To search for a vendor whose name includes a comma, enclose the entire search term in quotes. Otherwise, the Defense Center treats the term as two searches and returns events that match each search term. 
  
        
 
         
         	[bookmark: pgfId-3742390]Port
  
         	[bookmark: pgfId-3742392]Note that you cannot:
 
           
           	 [bookmark: pgfId-3742393]enter a port/protocol combination as you can when searching for other kinds of events
 
           	 [bookmark: pgfId-3742394]use spaces when specifying port numbers or ranges.
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3742401]To search for discovery events:
 
     [bookmark: pgfId-3742402]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3914567]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3914568]The Search page appears.
 
     [bookmark: pgfId-3914569]Step 2 Select Discovery Events from the table drop-down list.
 
     [bookmark: pgfId-3914570]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-3914576]Step 3 Enter your search criteria in the appropriate fields, as described in General Search Syntax and Special Search Syntax for Discovery Events. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3914584]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-3914585]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3914586]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3930168]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3930169]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3930170]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3930171]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-3914587]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-3914588]Your search results appear in the default discovery events workflow, constrained by the current time range. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3891837]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2296853][bookmark: 50229]Working with[bookmark: marker-2650198] Hosts
 
    [bookmark: pgfId-3548192]License: FireSIGHT
 
    [bookmark: pgfId-3535541]The system generates an event when it detects a host and collects information about it to build the host profile. You can use the Defense Center web interface to view, search, and delete hosts.
 
    [bookmark: pgfId-3535548]While viewing hosts, you can create traffic profiles and compliance white lists based on selected hosts. You can also assign host attributes, including host criticality values (which designate business criticality) to groups of hosts. You can then use these criticality values, white lists, and traffic profiles within correlation rules and policies. 
 
    [bookmark: pgfId-2818418]Although you can configure the network discovery policy to add hosts to the network map based on data exported by NetFlow-enabled devices, the available information about these hosts is limited. For example, there is no operating system data available for these hosts, unless you provide it using the host input feature. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
    [bookmark: pgfId-2315162]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-2315166]Viewing Hosts
 
     	 [bookmark: pgfId-2554387]Understanding the Hosts Table
 
     	 [bookmark: pgfId-2308288]Creating a Traffic Profile for Selected Hosts
 
     	 [bookmark: pgfId-2573064]Creating a Compliance White List Based on Selected Hosts
 
     	 [bookmark: pgfId-2814526]Searching for Hosts
 
     	 [bookmark: pgfId-2814587]Setting Host Attributes for Selected Hosts
 
    
 
     
      [bookmark: pgfId-2332998][bookmark: 95418]Viewing[bookmark: marker-2650199] Hosts
 
     [bookmark: pgfId-3548208]License: FireSIGHT
 
     [bookmark: pgfId-2307411]You can use the Defense Center to view a table of hosts that the system has detected. Then, you can manipulate the view depending on the information you are looking for.
 
     [bookmark: pgfId-2336679]The page you see when you access hosts differs depending on the workflow you use. Both predefined workflows terminate in a host view, which contains a host profile for every host that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs. For more information, see Creating Custom Workflows.
 
      
       
        
        [bookmark: pgfId-2373644]Table 50-4 [bookmark: 72994]Host Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-2373648]To... 
          
  
         	 
           
           [bookmark: pgfId-2373650]You can... 
          
  
        
 
         
         	[bookmark: pgfId-2373652]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-2373656]find more information in Understanding the Hosts Table.
  
        
 
         
         	[bookmark: pgfId-2814170]assign a host attribute to selected hosts
  
         	[bookmark: pgfId-2814174]find more information in Setting Host Attributes for Selected Hosts.
  
        
 
         
         	[bookmark: pgfId-2373666]create traffic profiles for selected hosts
  
         	[bookmark: pgfId-2373670]find more information in Creating a Traffic Profile for Selected Hosts.
  
        
 
         
         	[bookmark: pgfId-2553638]create a compliance white list based on selected hosts
  
         	[bookmark: pgfId-2553640]find more information in Creating a Compliance White List Based on Selected Hosts.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2307467]To view hosts:
 
     [bookmark: pgfId-3560749]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2307471]Step 1 Select Analysis > Hosts > Hosts.
 
     [bookmark: pgfId-2951523]The first page of the default hosts workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-2951902]Tip If you are using a custom workflow that does not include the table view of hosts, click (switch workflow), then select Hosts.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3891951]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2951908][bookmark: 92233]Understand[bookmark: marker-3654055]ing the Hosts Table
 
     [bookmark: pgfId-3548236]License: FireSIGHT
 
     [bookmark: pgfId-2789949]When the system discovers a host, it collects data about that host. That data can include the host’s IP addresses, the operating system it is running, and more. You can view some of that information in the table view of hosts. For more information on the data that the system collects about detected hosts, see Using Host Profiles.
 
     [bookmark: pgfId-2789959]Descriptions of the fields in the hosts table follow below.
 
     [bookmark: pgfId-2818531]Although you can configure the network discovery policy to add hosts to the network map based on data exported by NetFlow-enabled devices, the available information about these hosts is limited. For example, there is no operating system data available for these hosts, unless you provide it using the host input feature. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     [bookmark: pgfId-3762711][bookmark: marker-3762710]Last Seen
 
     [bookmark: pgfId-3762714]The date and time [bookmark: marker-3762713]any of the host’s IP addresses was last detected by the system. The Last Seen value is updated at least as often as the update interval you configured in the network discovery policy, as well as when the system generates a new host event for any of the host’s IP addresses.
 
     [bookmark: pgfId-3762715]For hosts with operating system data updated using the host input feature, the Last Seen value indicates the date and time when the data was originally added.
 
     [bookmark: pgfId-3762718][bookmark: marker-3762717]IP Address
 
     [bookmark: pgfId-3762720]The IP addresses associated with the host.
 
     [bookmark: pgfId-3762723][bookmark: marker-3762722]MAC Address
 
     [bookmark: pgfId-3762725]The host’s detected MAC address of the NIC.
 
     [bookmark: pgfId-3762726]The MAC Address field appears in the Table View of Hosts, which you can find in the Hosts workflow. You can also add the MAC Address field to:
 
     [bookmark: pgfId-3762727] – custom tables that include fields from the Hosts table
 
     [bookmark: pgfId-3762728] – drill-down pages in custom workflows based on the Hosts table
 
     [bookmark: pgfId-3762731][bookmark: marker-3762730]MAC Vendor
 
     [bookmark: pgfId-3762733]The host’s detected MAC hardware vendor of the NIC. 
 
     [bookmark: pgfId-3762734]The MAC Vendor field appears in the Table View of Hosts, which you can find in the Hosts workflow. You can also add the MAC Vendor field to:
 
     [bookmark: pgfId-3762735] – custom tables that include fields from the Hosts table
 
     [bookmark: pgfId-3762736] – drill-down pages in custom workflows based on the Hosts table
 
     [bookmark: pgfId-3762739][bookmark: marker-3762738]Current User
 
     [bookmark: pgfId-3762741]The user identity (username) of the currently logged in user on the host. 
 
     [bookmark: pgfId-3762742]Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.
 
     [bookmark: pgfId-3762745][bookmark: marker-3762744]Host Criticality
 
     [bookmark: pgfId-3762747]The user-specified criticality value assigned to the host. See the description of the Host Criticality column in Understanding the Host Attributes Table for more information about this field.
 
     [bookmark: pgfId-3762753][bookmark: marker-3762752]NetBIOS Name
 
     [bookmark: pgfId-3762755]The NetBIOS name of the host. Only hosts running the NetBIOS protocol will have a NetBIOS name.
 
     [bookmark: pgfId-3762758][bookmark: marker-3762757]VLAN ID
 
     [bookmark: pgfId-3762760]VLAN ID used by the host. For more detailed information about VLAN IDs, see Working with VLAN Tags in the Host Profile.
 
     [bookmark: pgfId-3762766][bookmark: marker-3762765]Hops
 
     [bookmark: pgfId-3762768]The number of network hops from the device that detected the host to the host.
 
     [bookmark: pgfId-3762771][bookmark: marker-3762770]Host Type
 
     [bookmark: pgfId-3762773]The type of host (host, mobile device, jailbroken mobile device, router, bridge, NAT device, or load balancer). The methods the system uses to distinguish network devices include:
 
     [bookmark: pgfId-3762774] – the analysis of Cisco Discovery Protocol (CDP) messages, which can identify network devices and their type (Cisco devices only)
 
     [bookmark: pgfId-3762775] – the detection of the Spanning Tree Protocol (STP), which identifies a device as a switch or bridge
 
     [bookmark: pgfId-3762776] – the detection of multiple hosts using the same MAC address, which identifies the MAC address as belonging to a router
 
     [bookmark: pgfId-3762777] – the detection of TTL value changes from the client side, or TTL values that change more frequently than a typical boot time, which identify NAT devices and load balancers
 
     [bookmark: pgfId-3762778]If a device is not identified as a network device, it is categorized as a host.
 
     [bookmark: pgfId-3762781][bookmark: marker-3762780]Hardware
 
     [bookmark: pgfId-3762783]The hardware platform for a mobile device.
 
     [bookmark: pgfId-3762786][bookmark: marker-3762785]OS
 
     [bookmark: pgfId-3762788]The detected operating system (name, vendor, and version) running on the host, or updated using Nmap or the host input feature. This field appears when you invoke the hosts event view from the Custom Analysis widget on the dashboard. It is also a field option in custom tables based on the Hosts table.
 
     [bookmark: pgfId-3762789]Note if the system detects multiple identities, it displays those identities in a comma-separated list.
 
     [bookmark: pgfId-3762790]In this field, a value of unknown means that the operating system does not match any of the known fingerprints. A value of pending means that the system has not yet gathered enough information to identify the operating system.
 
     [bookmark: pgfId-3762793][bookmark: marker-3762792]OS Vendor
 
     [bookmark: pgfId-3762795]The vendor of the operating system detected on the host or updated using Nmap or the host input feature.
 
     [bookmark: pgfId-3762796]Note if the system detects multiple vendors, it displays those vendors in a comma-separated list.
 
     [bookmark: pgfId-3762797]In this field, a value of unknown means that the operating system does not match any of the known fingerprints. A value of pending means that the system has not yet gathered enough information to identify the operating system.
 
     [bookmark: pgfId-3762800][bookmark: marker-3762799]OS Name
 
     [bookmark: pgfId-3762802]The detected operating system running on the host or updated using Nmap or the host input feature.
 
     [bookmark: pgfId-3762803]Note if the system detects multiple names, it displays those names in a comma-separated list.
 
     [bookmark: pgfId-3762804]In this field, a value of unknown means that the operating system does not match any of the known fingerprints. A value of pending means that the system has not yet gathered enough information to identify the operating system.
 
     [bookmark: pgfId-3762807][bookmark: marker-3762806]OS Version
 
     [bookmark: pgfId-3762809]The version of the operating system detected on the host or updated using Nmap or the host input feature.
 
     [bookmark: pgfId-3762810]Note if the system detects multiple versions, it displays those versions in a comma-separated list.
 
     [bookmark: pgfId-3762811]In this field, a value of unknown means that the operating system does not match any of the known fingerprints. A value of pending means that the system has not yet gathered enough information to identify the operating system.
 
     [bookmark: pgfId-3762814]Sourc[bookmark: marker-3762813]e Type
 
     [bookmark: pgfId-3762816]One of the following values for the source of the host’s operating system identity:
 
     [bookmark: pgfId-3762817] – User: user_name
 
     [bookmark: pgfId-3762818] – Application: app_name
 
     [bookmark: pgfId-3762819] – Scanner: scanner_type (Nmap or scanner added through network discovery configuration)
 
     [bookmark: pgfId-3762823] – FireSIGHT, for operating systems detected by the system
 
     [bookmark: pgfId-3762824]The system may reconcile data from multiple sources to determine the identity of an operating system; see Understanding Current Identities.
 
     [bookmark: pgfId-3762830][bookmark: marker-3762829]Confidence
 
     [bookmark: pgfId-3762832]One of:
 
     [bookmark: pgfId-3762833] – the percentage of confidence that the system has in the identity of the operating system running on the host, for hosts detected by the system
 
     [bookmark: pgfId-3762834] – 100%, for operating systems identified by an active source, such as the host input feature or Nmap scanner
 
     [bookmark: pgfId-3762835] – unknown, for hosts for which the system cannot determine an operating system identity, and for hosts added to the network map based on NetFlow data
 
     [bookmark: pgfId-3762837]Notes
 
     [bookmark: pgfId-3762839]The user-defined content of the Notes host attribute.
 
     [bookmark: pgfId-3762841]Device
 
     [bookmark: pgfId-3762843]Either the managed device that detected the traffic or the device that processed the NetFlow or host input data that added the host to the network map.
 
     [bookmark: pgfId-3989127]If this field is blank, either the host was added to the network map by a device that is not explicitly monitoring the network where the host resides, as defined in the network discovery policy, or the host was added using the host input feature and has not also been detected by the system.
 
     [bookmark: pgfId-3762850]Count
 
     [bookmark: pgfId-3762852]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-3548271][bookmark: 48744]Creating a Traffic Prof[bookmark: marker-3548270]ile for Selected Hosts
 
     [bookmark: pgfId-3548335]License: FireSIGHT
 
     [bookmark: pgfId-3548283]A traffic profile is a profile of the traffic on your network, based on connection data collected over a timespan that you specify. After you create a traffic profile, you can detect abnormal network traffic by evaluating new traffic against your profile, which presumably represents normal network traffic.
 
     [bookmark: pgfId-2332868]You can use the Hosts page to create a traffic profile for a group of hosts that you specify. The traffic profile will be based on connections detected where one of the hosts you specify is the initiating host. Use the sort and search features to isolate the hosts for which you want to create a profile.
 
     [bookmark: pgfId-2332869]To create a traffic profile for selected hosts:
 
     [bookmark: pgfId-2917576]Access: Admin
 
     
 
     [bookmark: pgfId-2332870]Step 1 On a table view in the hosts workflow, select the check boxes next to the hosts for which you want to create a traffic profile.
 
     [bookmark: pgfId-2332871]Step 2 At the bottom of the page, click Create Traffic Profile.
 
     [bookmark: pgfId-2332872]The Create Profile page appears, populated with the IP addresses of the hosts you specified as the hosts to be monitored.
 
     [bookmark: pgfId-2332873]Step 3 Modify and save the traffic profile according to your specific needs.
 
     [bookmark: pgfId-2332876]For more information on creating traffic profiles, see Creating Traffic Profiles.
 
     [bookmark: pgfId-3891971]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2553000][bookmark: 53084]Creating a Compliance White List Based [bookmark: marker-2650212]on Selected Hosts
 
     [bookmark: pgfId-3548355]License: FireSIGHT
 
     [bookmark: pgfId-2553962]Compliance white lists allow you to specify which operating systems, clients, and network, transport, or application protocols are allowed on your network. 
 
     [bookmark: pgfId-2554062]You can use the Hosts page to create a compliance white list based on the host profiles of a group of hosts that you specify. Use the sort and search features to isolate the hosts that you want to use to create a white list.
 
     [bookmark: pgfId-2553952]To create a compliance white list based on selected hosts:
 
     [bookmark: pgfId-2917581]Access: Admin
 
     
 
     [bookmark: pgfId-2553506]Step 1 On a table view in the hosts workflow, select the check boxes next to the hosts for which you want to create a white list.
 
     [bookmark: pgfId-2553507]Step 2 At the bottom of the page, click Create White List.
 
     [bookmark: pgfId-2553508]The Create White List page appears, populated with the information in the host profiles of the hosts you specified.
 
     [bookmark: pgfId-2553509]Step 3 Modify and save the white list according to your specific needs.
 
     [bookmark: pgfId-3219444]For more information on creating compliance white lists, see Creating Compliance White Lists.
 
     [bookmark: pgfId-3892068]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3892897][bookmark: 99284]Searching for [bookmark: marker-3892895]Hosts
 
     [bookmark: pgfId-3892905]License: FireSIGHT
 
     [bookmark: pgfId-3744051]You can search for specific hosts by using one of the predefined searches or by using your own search criteria. 
 
     [bookmark: pgfId-3744052]When searching for hosts, you should keep in mind that although you can configure the network discovery policy to add hosts to the network map based on data exported by NetFlow-enabled devices, the available information about these hosts is limited. For example, there is no operating system data available for these hosts, unless you provide it using the host input feature. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     [bookmark: pgfId-3744056]You can search for specific discovery events. You may want to create searches customized for your network environment, then save them to reuse later. 
 
     [bookmark: pgfId-3744057]General Search Syntax
 
     [bookmark: pgfId-3744058]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3744059]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3930450]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3930451]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3930452] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3930453] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3930454] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3930455]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3744061]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3744062]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3744063]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3744064]IP addresses may be specified using CIDR notation. For information on entering IP addresses in the FireSIGHT System, see IP Address Conventions. 
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-3813976]Note When you search for hosts by IP address, the results include all hosts for which at least one IP address matches your search conditions, that is, a search for an IPv6 address may return hosts whose primary address is IPv4.
 
      
      
 
     
 
     
 
      
      	 [bookmark: pgfId-3947088]Use the device field to search for specific devices as well as devices in groups, stacks, or clusters. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
      	 [bookmark: pgfId-3744068]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3744069]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3744073]Special Search Syntax for Hosts
 
      
       
        
        [bookmark: pgfId-3744084]Table 50-5 [bookmark: 68671]Host Search Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-3744088]Field 
          
  
         	 
           
           [bookmark: pgfId-3744090]Search Criteria Notes 
          
  
        
 
         
         	[bookmark: pgfId-3744092]Host Type
  
         	[bookmark: pgfId-3744094]To search for all network devices, type !host. 
  
        
 
         
         	[bookmark: pgfId-3744096]MAC Vendor
  
         	[bookmark: pgfId-3744098]To search for virtual MAC vendors, that is, for events that involve virtual machines, type virtual_mac_vendor.
 [bookmark: pgfId-3744099]To search for a vendor whose name includes a comma, enclose the entire search term in quotes. Otherwise, the Defense Center treats the term as two searches and returns events that match each search term.
  
        
 
         
         	[bookmark: pgfId-3744104]OS Vendor/Name/Version
  
         	[bookmark: pgfId-3744106]Type unknown to search for hosts where the operating system is unknown. Type n/a to search for hosts where the operating system has not yet been identified.
  
        
 
         
         	[bookmark: pgfId-3744108]Confidence
  
         	[bookmark: pgfId-3744110]You can precede the confidence with greater than (>), greater than or equal to (>=), less than (<), less than or equal to (<=), or equal to (=) operators. 
 [bookmark: pgfId-3744111]Matches to an n/a search include hosts added to the network map based on NetFlow data. 
  
        
 
         
         	[bookmark: pgfId-3744113]OS Conflict
  
         	[bookmark: pgfId-3744115]Note that the OS Conflict column does not appear in search results. To determine whether you are viewing hosts with or without operating system conflicts, expand the search constraints on the workflow page. For more information on resolving operating system conflicts, see Resolving Operating System Identity Conflicts.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3744120]For more information on searching, including how to load and delete saved searches, see Searching for Events.
 
     [bookmark: pgfId-3744124]To search for hosts:
 
     [bookmark: pgfId-3744125]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3915844]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3915845]The Search page appears.
 
     [bookmark: pgfId-3915846]Step 2 Select Hosts from the table drop-down menu.
 
     [bookmark: pgfId-3915847]The page updates with the appropriate constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-3915848]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3915857]Step 3 Enter your search criteria in the appropriate fields, as described in the Host Search Criteria table. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3915864]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-3935537]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3935538]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3935910]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3935911]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3935912]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3935913]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-3935539]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-3915868]Your search results appear in the default hosts workflow. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892080]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2308396][bookmark: 83923]Working with Host Attrib[bookmark: marker-2415322]utes
 
    [bookmark: pgfId-3548397]License: FireSIGHT
 
    [bookmark: pgfId-2315517]The FireSIGHT System collects information about the hosts it detects and uses that information to build host profiles. However, there may be additional information about the hosts on your network that you want to provide to your analysts. You can add notes to a host profile, set the business criticality of a host, or provide any other information that you choose. Each piece of information is called a host attribute.
 
    [bookmark: pgfId-2315897]You can use host attributes in host profile qualifications, which constrain the data you collect while building a traffic profile, and also can limit the conditions under which you want to trigger a correlation rule. You can also set attribute values in response to a correlation rule.
 
    [bookmark: pgfId-2315906]For more information, see:
 
     
     	 [bookmark: pgfId-2315913]Viewing Host Attributes
 
     	 [bookmark: pgfId-2554768]Understanding the Host Attributes Table
 
     	 [bookmark: pgfId-2310339]Setting Host Attributes for Selected Hosts
 
     	 [bookmark: pgfId-2333458]Searching for Host Attributes
 
     	 [bookmark: pgfId-2849556]Configuring Set Attribute Remediations
 
    
 
     
      [bookmark: pgfId-2310185][bookmark: 87675]Viewing Host Attrib[bookmark: marker-2415323]utes
 
     [bookmark: pgfId-3548425]License: FireSIGHT
 
     [bookmark: pgfId-2310354]You can use the Defense Center to view a table of hosts detected by the system, along with their host attributes. Then, you can manipulate the view depending on the information you are looking for.
 
     [bookmark: pgfId-2336699]The page you see when you access host attributes differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of host attributes that lists all detected hosts and their attributes, and terminates in a host view page, which contains a host profile for every host that meets your constraints.
 
     [bookmark: pgfId-2336693]You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
      
       
        
        [bookmark: pgfId-2558613]Table 50-6 [bookmark: 56641]Host Attribute Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-2558617]To... 
          
  
         	 
           
           [bookmark: pgfId-2558619]You can... 
          
  
        
 
         
         	[bookmark: pgfId-2558621]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-2558625]find more information in Understanding the Host Attributes Table.
  
        
 
         
         	[bookmark: pgfId-2558639]assign a host attribute to selected hosts
  
         	[bookmark: pgfId-2558643]find more information in Setting Host Attributes for Selected Hosts
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2558653]To view host attributes:
 
     [bookmark: pgfId-3560832]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2558657]Step 1 Select Analysis > Hosts > Host Attributes.
 
     [bookmark: pgfId-2952198]The first page of the default host attributes workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-2952554]Tip If you are using a custom workflow that does not include the table view of host attributes, click (switch workflow), then select Attributes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3892096]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2554619][bookmark: 66584]Understanding the[bookmark: marker-2650251] Host Attributes Table
 
     [bookmark: pgfId-3548449]License: FireSIGHT
 
     [bookmark: pgfId-2554623]The FireSIGHT System collects information about the hosts it detects and uses that information to build host profiles. However, there may be additional information about the hosts on your network that you want to provide to your analysts. You can add notes to a host profile, set the business criticality, or provide any other information that you choose. Each piece of information is called a host attribute.
 
     [bookmark: pgfId-2554624]You can use host attributes in host profile qualifications, which constrain the data you collect while building a traffic profile, and also can limit the conditions under which you want to trigger a correlation rule.
 
     [bookmark: pgfId-3821339]Note that the host attributes table does not display hosts identified only by MAC addresses.
 
     [bookmark: pgfId-2554627]For more information on host attributes, see Working with the Predefined Host Attributes and Working with User-Defined Host Attributes.
 
     [bookmark: pgfId-2554634]Descriptions of the fields in the host attributes table follow.
 
     [bookmark: pgfId-3763394]IP Address
 
     [bookmark: pgfId-3763396]The IP addresses associated with a host.
 
     [bookmark: pgfId-3763398]Current User
 
     [bookmark: pgfId-3763400]The user identity (username) of the currently logged in user on the host. 
 
     [bookmark: pgfId-3763401]Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.
 
     [bookmark: pgfId-3763403]Host Criticality
 
     [bookmark: pgfId-3763405]The user-assigned importance of a host to your enterprise. You can use the host criticality in correlation rules and policies to tailor policy violations and their responses to the importance of a host involved in an event. You can assign a host criticality of low, medium, high, or none.
 
     [bookmark: pgfId-3763408]For information on setting a host’s criticality, see Working with the Predefined Host Attributes and Setting Host Attributes for Selected Hosts.
 
     [bookmark: pgfId-3763414]Notes
 
     [bookmark: pgfId-3763416]Information about the host that you want other analysts to view. For information on how to add a note, see Working with the Predefined Host Attributes.
 
     [bookmark: pgfId-3763421]Any user-defined host attribute, including those for compliance white lists
 
     [bookmark: pgfId-3763423]The value of the user-defined host attribute.
 
     [bookmark: pgfId-3763424]The host attributes table contains a field for each user-defined host attribute. For more information, see Working with User-Defined Host Attributes.
 
     [bookmark: pgfId-3763429]Count
 
     [bookmark: pgfId-3763431]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-2558728][bookmark: 31331]Setting Host Attributes for[bookmark: marker-2650253] Selected Hosts
 
     [bookmark: pgfId-3548465]License: FireSIGHT
 
     [bookmark: pgfId-2316048]There are two predefined host attributes that you can assign to each host: host criticality and host-specific notes.
 
     [bookmark: pgfId-2316087]Use the host criticality to designate the business criticality of a given host. You can tailor correlation policies and alerts based on host criticality. For example, your organization’s mail servers are more critical to your business than a typical user workstation. You can assign a high host criticality value to your mail servers and other business-critical servers and medium or low values to other hosts. You could then create a correlation policy that launches different alerts based on the criticality of an affected host.
 
     [bookmark: pgfId-2316016]Use notes to record information about a host that you want other analysts to view. For example, if you have a computer on the network that has an older, unpatched version of an operating system that you use for testing, you can use the notes feature to indicate that the system is intentionally unpatched.
 
     [bookmark: pgfId-2334024]You can also create user-defined host attributes. For example, you could create a host attribute that assigns physical location identifiers to hosts, such as a facility code, city, or room number. For more information on created user-defined host attributes, see Creating User-Defined Host Attributes.
 
     [bookmark: pgfId-2334028]You can also set the host criticality of selected hosts in a host workflow, and from within a host profile, or set it through a remediation. For more information, see Working with the Predefined Host Attributes or Configuring Set Attribute Remediations. 
 
     [bookmark: pgfId-2334035]To set host attributes for selected hosts:
 
     [bookmark: pgfId-3560869]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2334036]Step 1 Select the check boxes next to the hosts to which you want to add a host attribute.
 
      
       
     
 
     
 
     [bookmark: pgfId-2815016]Tip Use the sort and search features to isolate the hosts to which you want to assign particular attributes.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2334037]Step 2 At the bottom of the page, click Set Attributes.
 
     [bookmark: pgfId-2672920]The Host Attributes pop-up window appears.
 
     [bookmark: pgfId-2334039]Step 3 Optionally, set the host criticality for the hosts you selected.
 
     [bookmark: pgfId-2334040]You can select None, Low, Medium, or High.
 
     [bookmark: pgfId-2334041]Step 4 Optionally, add notes to the host profiles of the hosts you selected by entering up to 255 alphanumeric characters, special characters, and spaces in the text box.
 
     [bookmark: pgfId-2334042]Step 5 Optionally, set any user-defined host attributes you have configured.
 
     [bookmark: pgfId-2334043]Step 6 Click Save.
 
     [bookmark: pgfId-2334044]The host attributes you specified are assigned to the selected hosts.
 
     [bookmark: pgfId-3892108]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3744744][bookmark: 39486]Searching for[bookmark: marker-3744743] Host Attributes
 
     [bookmark: pgfId-3744749]License: FireSIGHT
 
     [bookmark: pgfId-3744750]You can search for hosts that have specific host attributes. For example, if your company has several regional offices, you could configure a host attribute that tells you which city any one host resides in. You could then search for hosts in specific regions. For more information on host attributes, see Working with User-Defined Host Attributes.
 
     [bookmark: pgfId-3744754]You may want to create searches customized for your network environment, then save them to reuse later. For more information on the host attribute fields, see Understanding the Host Attributes Table.
 
     [bookmark: pgfId-3744758]General Search Syntax
 
     [bookmark: pgfId-3744759]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3744760]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3930703]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3930704]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3930705] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3930706] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3930707] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3930708]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3744762]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3744763]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3744764]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3744765]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3744769]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3744770]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3744774]To search for host attributes:
 
     [bookmark: pgfId-3744775]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3916709]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3916710]The Search page appears.
 
     [bookmark: pgfId-3916711]Step 2 From the table drop-down list, select Host Attributes.
 
     [bookmark: pgfId-3916712]The page updates with the appropriate constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-3916713]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3916721]Step 3 Enter your search criteria in the appropriate fields, as described in Understanding the Host Attributes Table. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3916729]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-3916730]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3916731]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3931211]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3931212]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3931213]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3931214]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-3916732]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-3916733]Your search results appear in the default host attributes workflow. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892129]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3826578][bookmark: 13297]Working with Indications of Compromise[bookmark: marker-3838648]
 
    [bookmark: pgfId-3826628]License: FireSIGHT
 ); you also can write compliance rules that account for IOC-tagged hosts. 
    
 
    [bookmark: pgfId-3827191]To use this feature, you must have IOC rules enabled in your network discovery policy. You can enable any or all of the predefined rules to trigger IOC tags on compromised hosts. For more information, see Setting Indications of Compromise Rules.
 
    [bookmark: pgfId-3829668]See the following sections for detailed information about indications of compromise:
 
     
     	 [bookmark: pgfId-3829758]Viewing Indications of Compromise
 
     	 [bookmark: pgfId-3829795]Understanding the Indications of Compromise Table
 
     	 [bookmark: pgfId-3829817]Searching for Indications of Compromise
 
    
 
     
      [bookmark: pgfId-3829274][bookmark: 73037]Viewing Indications of Compromise
 
     [bookmark: pgfId-3829425]License: FireSIGHT
 
     [bookmark: pgfId-3829450]You can use the Defense Center to view a table of triggered Indications of Compromise (IOC). Then, you can manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-3830427]The page you see when you access IOC depends on the workflow you use. Both predefined IOC workflows terminate in a host view, which contains a host profile for every host that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs. For more information, see Creating Custom Workflows.
 
     [bookmark: pgfId-3830476]The following table describes some of the specific actions you can perform on an IOC workflow page. You can also perform the tasks described in the Common Discovery Event Actions table.
 
     [bookmark: pgfId-3830678]
 
      
      
 
      
 
       
        
        [bookmark: pgfId-3830726]Table 50-7 Indication of Compromise Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3830730]To... 
          
  
         	 
           
           [bookmark: pgfId-3830732]You can... 
          
  
        
 
         
         	[bookmark: pgfId-3830734]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-3830736]find more information in Understanding the Indications of Compromise Table.
  
        
 
         
         	[bookmark: pgfId-3830738]view the host profile for a compromised host
  column. 
        
 
         
         	[bookmark: pgfId-3830742]mark selected IOC events resolved so they no longer appear in the list
  
         	[bookmark: pgfId-3830744]select the check boxes next to the IOC events you want to edit, then click Mark Resolved. For more information, see Resolving Indications of Compromise.
  
        
 
         
         	[bookmark: pgfId-3833028]view details of events that triggered the IOC
  columns. 
        
 
        
      
 
     
 
     [bookmark: pgfId-3830684]To view indications of compromise:
 
     [bookmark: pgfId-3831444]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3831647]Step 1 Select Analysis > Hosts > Indications of Compromise.
 
     [bookmark: pgfId-3831648]The first page of the default indications of compromise (IOC) workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-3831652]Tip If you are using a custom workflow that does not include the IOC table view, click (switch workflow), then select Indications of Compromise.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3892153]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3829604][bookmark: 57821]Understanding the Indications of Compromise Table
 
     [bookmark: pgfId-3829608]License: FireSIGHT
 
     [bookmark: pgfId-3829610]The FireSIGHT System correlates various types of event data associated with hosts to determine whether a host on your monitored network is likely to be compromised by malicious means. These correlations appear, associated with the host, as indications of compromise (IOC). You can mark a host IOC as resolved, which removes that IOC tag from the host. A host can trigger multiple IOC tags; you can view all IOC tags associated with a host in the Indications of Compromise section of the host profile. For more information on IOC data in the host profile, see Working with Indications of Compromise in the Host Profile.
 
     [bookmark: pgfId-3831870]Descriptions of the fields in the IOC table follow below.
 
     [bookmark: pgfId-3832528]IP Address
 
     [bookmark: pgfId-3832574]The IP address associated with the host that triggered the IOC.
 
     [bookmark: pgfId-3832680]Category
 
     [bookmark: pgfId-3832690]Brief description of the type of compromise indicated, such as Malware Executed or Impact 1 Attack.
 
     [bookmark: pgfId-3832863]Event Type
 
     [bookmark: pgfId-3832887]Identifier associated with a specific Indication of Compromise (IOC), referring to the event that triggered it.
 
     [bookmark: pgfId-3832911]Description
 
     [bookmark: pgfId-3832938]Description of what the IOC means for the potentially compromised host, such as This host may be under remote control or Malware has been executed on this host.
 
     [bookmark: pgfId-3832951]First/Last Seen
 
     [bookmark: pgfId-3832981]The first (or most recent) date and time that events triggering a host’s IOC occurred.
 
    
 
     
      [bookmark: pgfId-3829368][bookmark: 96251]Searching for Indications of Compromise
 
     [bookmark: pgfId-3829625]License: FireSIGHT
 
     [bookmark: pgfId-3838252]You can search for specific indications of compromise (IOC) tags triggered on monitored hosts by using one of the predefined searches or by using your own search criteria. The predefined searches serve as examples and can provide quick access to important information about your network. 
 
     [bookmark: pgfId-3833800]You may want to modify specific fields within the default searches to customize them for your network environment, then save them to reuse later. The fields you can use to retrieve data are described in Understanding the Indications of Compromise Table.
 
     [bookmark: pgfId-3833965]General Search Syntax
 
     [bookmark: pgfId-3833966]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3833967]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3931357]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3931358]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3931359] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3931360] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3931361] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3931362]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3833969]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3833970]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3833971]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3833972]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3833982]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3833983]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3833987]To search for indications of compromise:
 
     [bookmark: pgfId-3833988]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3917203]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3917204]The Search page appears.
 
     [bookmark: pgfId-3917205]Step 2 Select Indications of Compromise from the table drop-down list.
 
     [bookmark: pgfId-3917206]The page updates with the appropriate constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-3917207]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3917215]Step 3 Enter your search criteria in the appropriate fields, as described in Understanding the Indications of Compromise Table. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3917223]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-3917224]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3917225]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3931890]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3931891]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3931892]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3931893]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-3931636]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-3917227]Your search results appear in the default IOC workflow. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892169]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2296859][bookmark: 54802]Working with Ser[bookmark: marker-2415324]vers
 
    [bookmark: pgfId-3548498]License: FireSIGHT
 
    [bookmark: pgfId-2316503]The FireSIGHT System collects information about all servers running on hosts on monitored network segments. The information that the system collects includes the name of the server, the application and network protocols used by the server, the vendor and version of the server, the IP address associated with the host running a server, and the port on which the server communicates.
 
    [bookmark: pgfId-3443002]When the system detects a server, it generates a discovery event unless the associated host has already reached its maximum number of servers. For more information, see Host Limits and Discovery Event Logging. You can use the Defense Center web interface to view, search, and delete server events.
 
    [bookmark: pgfId-3443010]You can also base correlation rules on server events. For example, you could trigger a correlation rule when the system detects a chat server, such as ircd, running on one of your hosts.
 
    [bookmark: pgfId-2819096]Although you can configure the network discovery policy to add servers to the network map based on application data exported by NetFlow-enabled devices, the available information about these servers is limited. For more information, see Differences Between NetFlow and FireSIGHT Data. 
 
    [bookmark: pgfId-2316814]See the following sections for more information:
 
     
     	 [bookmark: pgfId-2316642]Viewing Servers
 
     	 [bookmark: pgfId-2555103]Understanding the Servers Table
 
     	 [bookmark: pgfId-2316475]Searching for Servers
 
     	 [bookmark: pgfId-2878252]Editing Server Identities
 
    
 
     
      [bookmark: pgfId-2310518][bookmark: 77637]Viewing Serve[bookmark: marker-2415325]rs
 
     [bookmark: pgfId-3548514]License: FireSIGHT
 
     [bookmark: pgfId-2336525]You can use the Defense Center to view a table of detected servers. Then, you can manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-3598053]The page you see when you access servers differs depending on the workflow you use. All the predefined workflows terminate in a host view, which contains a host profile for every host that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs. For more information, see Creating Custom Workflows.
 
     [bookmark: pgfId-2320360]The Server Actions table below describes some of the specific actions you can perform on an servers workflow page. You can also perform the tasks described in the Common Discovery Event Actions table.
 
     [bookmark: pgfId-2320397]
 
      
       
        
        [bookmark: pgfId-3753004]Table 50-8 [bookmark: 29070]Server Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3753008]To... 
          
  
         	 
           
           [bookmark: pgfId-3753010]You can... 
          
  
        
 
         
         	[bookmark: pgfId-3753012]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-3753016]find more information in Understanding the Servers Table.
  
        
 
         
         	[bookmark: pgfId-3753019]edit server identities
  
         	[bookmark: pgfId-3753021]select the check boxes next to the events for servers you want to edit, then click Set Server Identity. For more information, see Editing Server Identities.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2320401]To view[bookmark: marker-2650263] servers:
 
     [bookmark: pgfId-3560956]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2320405]Step 1 Select Analysis > Hosts > Servers.
 
     [bookmark: pgfId-2952423]The first page of the default servers workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-2556200]Tip If you are using a custom workflow that does not include the table view of servers, click (switch workflow), then select Servers.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3892181]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2500603][bookmark: 17179]Understanding the[bookmark: marker-2650264] Servers Table
 
     [bookmark: pgfId-3548538]License: FireSIGHT
 
     [bookmark: pgfId-3623974]The FireSIGHT System collects information about servers running on hosts on monitored network segments.
 
     [bookmark: pgfId-2500614]Descriptions of the fields in the servers table follow below.
 
     [bookmark: pgfId-2819013]Although you can configure the network discovery policy to add servers to the network map based on data exported by NetFlow-enabled devices, the available information about these servers is limited. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     [bookmark: pgfId-3764070]Last Used
 
     [bookmark: pgfId-3764073]The date and time [bookmark: marker-3764072]the server was last used on the network or the date and time that the server was originally updated using the host input feature. The Last Used value is updated at least as often as the update interval you configured in the network discovery policy, as well as when the system detects a server information update. For information on setting the update interval, see Configuring Data Storage.
 
     [bookmark: pgfId-3764078]IP Address
 
     [bookmark: pgfId-3764080]The IP address associated with the host running the server. 
 
     [bookmark: pgfId-3764082]Port
 
     [bookmark: pgfId-3764084]The port where the server is running.
 
     [bookmark: pgfId-3764086]Protocol
 
     [bookmark: pgfId-3764088]The network or transport protocol used by the server.
 
     [bookmark: pgfId-3764090]Application Protocol
 
     [bookmark: pgfId-3764092]The application protocol, as indicated by one of the following:
 
     [bookmark: pgfId-3764093] – the name of the application protocol for the server
 
     [bookmark: pgfId-3764094] – pending, if the system cannot positively or negatively identify the server for one of several reasons
 
     [bookmark: pgfId-3764095] – unknown, if the system cannot identify the server based on known server fingerprints or if the server was added through host input and did not include the application protocol
 
     [bookmark: pgfId-3764098]Cate[bookmark: marker-3764097]gory, Tags, Risk, or Business Relevance for Application Protocols
 
     [bookmark: pgfId-3764100]The categories, tags, risk level, and business relevance assigned to the application protocol. These filters can be used to focus on a specific set of data. For more information, see Table 45-2. 
 
     [bookmark: pgfId-3764106]Vendor
 
     [bookmark: pgfId-3764108]One of:
 
     [bookmark: pgfId-3764109] – the server vendor as identified by the system, Nmap or another active source, or that you specified using the host input feature
 
     [bookmark: pgfId-3764112] – blank, if the system cannot identify its vendor based on known server fingerprints, or if the server was added to the network map using NetFlow data
 
     [bookmark: pgfId-3764114]Version
 
     [bookmark: pgfId-3764116]One of:
 
     [bookmark: pgfId-3764117] – the server version as identified by the system, Nmap or another active source, or that you specified using the host input feature
 
     [bookmark: pgfId-3764120] – blank, if the system cannot identify its version based on known server fingerprints, or if the server was added to the network map using NetFlow data
 
     [bookmark: pgfId-3764123]Web [bookmark: marker-3764122]Application
 
     [bookmark: pgfId-3764125]The web application based on the payload content detected by the system in the http traffic. Note that if the system detects an application protocol of HTTP but cannot detect a specific web application, the system supplies a generic web browsing designation.
 
     [bookmark: pgfId-3764127]Category, Tags, Risk, or Business Relevance for Web Applications
 
     [bookmark: pgfId-3764129]The categories, tags, risk level, and business relevance assigned to the web application. These filters can be used to focus on a specific set of data. For more information, see Table 45-2. 
 
     [bookmark: pgfId-3764135]Hits
 
     [bookmark: pgfId-3764137]The number of times the server was accessed. For servers added using the host input feature, this value is always 0.
 
     [bookmark: pgfId-3764140]Sourc[bookmark: marker-3764139]e Type
 
     [bookmark: pgfId-3764142]One of the following values:
 
     [bookmark: pgfId-3764143] – User: user_name
 
     [bookmark: pgfId-3764144] – Application: app_name
 
     [bookmark: pgfId-3764145] – Scanner: scanner_type (Nmap or scanner added through network discovery configuration)
 
     [bookmark: pgfId-3764155] – FireSIGHT, FireSIGHT Port Match, or FireSIGHT Pattern Match, for servers detected by the FireSIGHT System
 
     [bookmark: pgfId-3764159] – NetFlow, for servers added to the network map based on NetFlow data
 
     [bookmark: pgfId-3764160]The system may reconcile data from multiple sources to determine the identity of a server; see Understanding Current Identities. 
 
     [bookmark: pgfId-3764165]Device
 
     [bookmark: pgfId-3764167]The name of the device that either detected the server or processed the NetFlow or host input data that added the server to the network map.
 
     [bookmark: pgfId-3764169]Current User
 
     [bookmark: pgfId-3764171]The user identity (username) of the currently logged in user on the host. 
 
     [bookmark: pgfId-3764172]Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.
 
     [bookmark: pgfId-3764174]Count
 
     [bookmark: pgfId-3764176]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-2558892][bookmark: 32563]Searc[bookmark: marker-2415326]hing for Servers
 
     [bookmark: pgfId-3548554]License: FireSIGHT
 
     [bookmark: pgfId-2312585]You can search for specific servers that are running on monitored hosts by using one of the predefined searches or by using your own search criteria. The predefined searches serve as examples and can provide quick access to important information about your network. 
 
     [bookmark: pgfId-3833942]You may want to modify specific fields within the default searches to customize them for your network environment, then save them to reuse later. The fields you can use to retrieve data are described in Understanding the Servers Table.
 
     [bookmark: pgfId-3755778]When searching for servers, you should keep in mind that although you can configure the network discovery policy to add applications, including servers, to the network map based on data exported by NetFlow-enabled devices, the available information about these servers is limited. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     [bookmark: pgfId-3755964]General Search Syntax
 
     [bookmark: pgfId-3755965]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3755966]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3932000]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3932001]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3932002] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3932003] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3932004] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3932005]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3755968]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3755969]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3755970]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3917550]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3947925]Use the device field to search for specific devices as well as devices in groups, stacks, or clusters. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
      	 [bookmark: pgfId-3917560]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3755976]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-2312675]To search for servers:
 
     [bookmark: pgfId-3561067]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3561579]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3561580]The Search page appears.
 
     [bookmark: pgfId-3561581]Step 2 From the table drop-down list, select Servers.
 
     [bookmark: pgfId-3561582]The page updates with the appropriate constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-3338872]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2312687]Step 3 Enter your search criteria in the appropriate fields. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3503531]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3503536]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2312695]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3932374]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3932375]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3932376]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3932377]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-2312696]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-2955069]Your search results appear in the default servers workflow. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892291]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3611340][bookmark: 15197]Working with Appl[bookmark: marker-3654081]ications[bookmark: marker-3611339]
 
    [bookmark: pgfId-3611344]License: FireSIGHT
 
    [bookmark: pgfId-3611345]When a monitored host connects to another host, the system can, in many cases, determine what application was used. The FireSIGHT System detects the use of many email, instant messaging, peer to peer, web applications, as well as other types of applications.
 
    [bookmark: pgfId-3611349]For each detected application, the system logs the IP address that used the application, the product, the version, and the number of times its use was detected. You can use the web interface to view, search, and delete application events. You can also update application data on a host or hosts using the host input feature. 
 
    [bookmark: pgfId-3611350]If you know which applications are running on which hosts, you can use that knowledge to create host profile qualifications, which constrain the data you collect while building a traffic profile, and also can limit the conditions under which you want to trigger a correlation rule. You can also base correlation rules on the detection of application. For example, if you want your employees to use a specific mail client, you could trigger a correlation rule when the system detects a different mail client running on one of your hosts.
 
    [bookmark: pgfId-3611356]You should carefully read the release notes for each FireSIGHT System update as well as the advisories for each VDB update for information on updated detectors.
 
    [bookmark: pgfId-3611367]To collect and store application data for analysis, make sure that you enable application detection in your network discovery policy. For more information, see Understanding Discovery Data Collection.
 
    [bookmark: pgfId-3611371]See the following sections for more information:
 
     
     	 [bookmark: pgfId-3611375]Viewing Application Details
 
     	 [bookmark: pgfId-3611379]Understanding the Application Detail Table
 
     	 [bookmark: pgfId-3611383]Searching for Application Details
 
    
 
     
      [bookmark: pgfId-3611388][bookmark: 64582]Viewing [bookmark: marker-3611387]Applica[bookmark: marker-3654086]tions
 
     [bookmark: pgfId-3611394]License: FireSIGHT
 
     [bookmark: pgfId-3611398]You can use the Defense Center to view a table of detected applications. Then, you can manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-3611399]The page you see when you access applications differs depending on the workflow you use. You can also create a custom workflow that displays only the information that matches your specific needs. For more information, see Creating Custom Workflows.
 
      
      
 
       
        
        [bookmark: pgfId-3611419]Table 50-9 [bookmark: 64384]Application Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3611423]To... 
          
  
         	 
           
           [bookmark: pgfId-3611425]You can... 
          
  
        
 
         
         	[bookmark: pgfId-3611427]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-3611431]find more information in Understanding the Applications Table.
  
        
 
         
         	[bookmark: pgfId-3611446]open the Application Detail View for a specific application
  ) next to a client, application protocol, or web application. 
        
 
        
      
 
     
 
     [bookmark: pgfId-3611450]To view applications:
 
     [bookmark: pgfId-3611451]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3611452]Step 1 Select Analysis > Hosts > Application Details.
 
     [bookmark: pgfId-3611453]The first page of the default application details workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-3611457]Tip If you are using a custom workflow that does not include the table view of application details, click (switch workflow), then select Clients.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3611460][bookmark: 29396]Understanding the [bookmark: marker-3611459]Applica[bookmark: marker-3654094]tions Table
 
     [bookmark: pgfId-3611464]License: FireSIGHT
 
     [bookmark: pgfId-3611468]When a monitored host connects to another host, the FireSIGHT System can, in many cases, determine what application was used. The system detects various web browsers or servers, email clients or servers, instant messengers, peer-to-peer applications, and so on. When the system detects traffic for a known client, application protocol, or web application, it logs information about the application and the host running it. 
 
     [bookmark: pgfId-3614137]The FireSIGHT System classifies application data into three types: client, web application, and application protocol. The applications table provides a list combining all three types of detected applications on the appliance. 
 
     [bookmark: pgfId-3611472]Descriptions of the fields in the applications table follow.
 
     [bookmark: pgfId-3764412]Application
 
     [bookmark: pgfId-3764414]The name of the detected application.
 
     [bookmark: pgfId-3764416]IP Address
 
     [bookmark: pgfId-3764418]The IP address associated with the host using the application.
 
     [bookmark: pgfId-3764421]Cate[bookmark: marker-3764420]gory
 
     [bookmark: pgfId-3764423]A general classification for the application that describes its most essential function. Each application belongs to at least one category.
 
     [bookmark: pgfId-3764426]T[bookmark: marker-3764425]ag
 
     [bookmark: pgfId-3764428]Additional information about the application. Applications can have any number of tags, including none.
 
     [bookmark: pgfId-3764431]Ri[bookmark: marker-3764430]sk
 
     [bookmark: pgfId-3764433]How likely the application is to be used for purposes that might be against your organization’s security policy. An application’s risk can range from Very Low to Very High.
 
     [bookmark: pgfId-3764434]Of Application Protocol Risk, Client Risk, and Web Application Risk, the highest of the three detected, when available, in the traffic that triggered the intrusion event.
 
     [bookmark: pgfId-3764437]Bu[bookmark: marker-3764436]siness Relevance
 
     [bookmark: pgfId-3764439]The likelihood that the application is used within the context of your organization’s business operations, as opposed to recreationally. An application’s business relevance can range from Very Low to Very High.
 
     [bookmark: pgfId-3764440]Of Application Protocol Business Relevance, Client Business Relevance, and Web Application Business Relevance, the lowest of the three detected, when available, in the traffic that triggered the intrusion event.
 
     [bookmark: pgfId-3764443]Curre[bookmark: marker-3764442]nt User
 
     [bookmark: pgfId-3764445]The user identity (username) of the currently logged in user on the host. 
 
     [bookmark: pgfId-3764446]Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.
 
     [bookmark: pgfId-3764448]Type
 
     [bookmark: pgfId-3764450]The type of application:
 
     [bookmark: pgfId-3764451] – Application Protocols represent communications between hosts.
 
     [bookmark: pgfId-3764452] – Client Applications represent software running on a host.
 
     [bookmark: pgfId-3764453] – Web Applications represent the content or requested URL for HTTP traffic.
 
     [bookmark: pgfId-3764455]Count
 
     [bookmark: pgfId-3764457]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-3611587][bookmark: 69616]Searching for [bookmark: marker-3611585]Applications
 
     [bookmark: pgfId-3611592]License: FireSIGHT
 
     [bookmark: pgfId-3622308]You can search for hosts that are running specific clients, application protocols, or web applications. You may want to create searches customized for your network environment, then save them to reuse later. 
 
     [bookmark: pgfId-3765070]General Search Syntax
 
     [bookmark: pgfId-3765071]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3765072]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3932441]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3932442]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3932443] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3932444] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3932445] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3932446]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3765074]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3765075]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3765076]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3765077]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3765081]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3765082]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3611739]To search for applications:
 
     [bookmark: pgfId-3611740]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3611741]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3611742]The Search page appears.
 
     [bookmark: pgfId-3611743]Step 2 Select Applications from the table drop-down list.
 
     [bookmark: pgfId-3611744]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-3611755]Step 3 Enter your search criteria in the appropriate fields. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3611762]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-3611763]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3611764]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3932739]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3932740]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3932741]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3932742]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-3611765]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-3611766]Your search results appear in the default clients workflow. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892318]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2296861][bookmark: 89197]Working with Appli[bookmark: marker-3654102]cation Details[bookmark: marker-2415327]
 
    [bookmark: pgfId-3548570]License: FireSIGHT
 
    [bookmark: pgfId-3346908]When a monitored host connects to another host, the system can, in many cases, determine what application was used. The FireSIGHT System detects the use of many email, instant messaging, peer to peer, web applications, as well as other types of applications.
 
    [bookmark: pgfId-2321186]For each detected application, the system logs the IP address that used the application, the product, the version, and the number of times its use was detected. You can use the web interface to view, search, and delete application events. You can also update application data on a host or hosts using the host input feature. 
 
    [bookmark: pgfId-2321360]If you know which applications are running on which hosts, you can use that knowledge to create host profile qualifications, which constrain the data you collect while building a traffic profile, and also can limit the conditions under which you want to trigger a correlation rule. You can also base correlation rules on the detection of application. For example, if you want your employees to use a specific mail client, you could trigger a correlation rule when the system detects a different mail client running on one of your hosts.
 
    [bookmark: pgfId-3416845]You should carefully read the release notes for each FireSIGHT System update as well as the advisories for each VDB update for information on updated detectors.
 
    [bookmark: pgfId-3398134]To collect and store application data for analysis, make sure that you enable application detection in your network discovery policy. For more information, see Understanding Application Detection.
 
    [bookmark: pgfId-2321236]See the following sections for more information:
 
     
     	 [bookmark: pgfId-2321214]Viewing Application Details
 
     	 [bookmark: pgfId-2555107]Understanding the Application Detail Table
 
     	 [bookmark: pgfId-2321218]Searching for Application Details
 
    
 
     
      [bookmark: pgfId-2310523][bookmark: 64408]Viewing [bookmark: marker-2415328]Application Details
 
     [bookmark: pgfId-3548586]License: FireSIGHT
 
     [bookmark: pgfId-2336809]You can use the Defense Center to view a table of detected application details. Then, you can manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-3534854]The page you see when you access application details differs depending on the workflow you use. There are two predefined workflows. You can also create a custom workflow that displays only the information that matches your specific needs. For more information, see Creating Custom Workflows.
 
      
      
 
       
        
        [bookmark: pgfId-2321753]Table 50-10 [bookmark: 23712]Application Details Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-2321757]To... 
          
  
         	 
           
           [bookmark: pgfId-2321759]You can... 
          
  
        
 
         
         	[bookmark: pgfId-2321761]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-2321765]find more information in Understanding the Application Detail Table.
  
        
 
         
         	[bookmark: pgfId-3613321]open the Application Detail View for a specific application
  ) next to a client. 
        
 
        
      
 
     
 
     [bookmark: pgfId-3561191]To view application details:
 
     [bookmark: pgfId-3561192]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3561193]Step 1 Select Analysis > Hosts > Application Details.
 
     [bookmark: pgfId-3561194]The first page of the default application details workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-3602000]Tip If you are using a custom workflow that does not include the table view of application details, click (switch workflow), then select Clients.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3892339]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3602003][bookmark: 49574]Understanding the [bookmark: marker-3602002]Application Detail Table
 
     [bookmark: pgfId-3602007]License: FireSIGHT
 
     [bookmark: pgfId-3624548]When a monitored host connects to another host, the FireSIGHT System can, in many cases, determine what application was used. The system detects various web browsers, email clients, instant messengers, peer-to-peer applications, and so on.
 
     [bookmark: pgfId-3624535]When the system detects traffic for a known client, application protocol, or web application, it logs information about the application and the host running it. Descriptions of the fields in the application details table follow.
 
     [bookmark: pgfId-3765574]Last Used
 
     [bookmark: pgfId-3765576]The time that the application was last used or the time that the application data was updated using the host input feature. The Last Used value is updated at least as often as the update interval you configured in the network discovery policy, as well as when the system detects an application information update. For information on setting the update interval, see Configuring Data Storage. 
 
     [bookmark: pgfId-3765581]IP Address
 
     [bookmark: pgfId-3765583]The IP address associated with the host using the application.
 
     [bookmark: pgfId-3765586]Clie[bookmark: marker-3765585]nt
 
     [bookmark: pgfId-3765588]The name of the application. Note that if the system detected an application protocol but could not detect a specific client, client is appended to the application protocol name to provide a generic name.
 
     [bookmark: pgfId-3765590]Version
 
     [bookmark: pgfId-3923894]The version of the application.
 
     [bookmark: pgfId-3923914]C[bookmark: marker-3923913]ategory, Tags, Risk, or Business Relevance for Clients, Application Protocols, and Web Applications
 
     [bookmark: pgfId-3923915]The categories, tags, risk level, and business relevance assigned to the application. These filters can be used to focus on a specific set of data. For more information, see Table 45-2.
 
     [bookmark: pgfId-3923654]Appl[bookmark: marker-3923653]ication Protocol
 
     [bookmark: pgfId-3765606]The application protocol used by the application. Note that if the system detected an application protocol but could not detect a specific client, client is appended to the application protocol name to provide a generic name.
 
     [bookmark: pgfId-3923908]Web [bookmark: marker-3923907]Application
 
     [bookmark: pgfId-3923910]The web application based on the payload content or URL detected by the system in the http traffic. Note that if the system detects an application protocol of HTTP but cannot detect a specific web application, the system supplies a generic web browsing designation here.
 
     [bookmark: pgfId-3765629]Hits
 
     [bookmark: pgfId-3765631]The number of times the system detected the application in use. For applications added using the host input feature, this value is always 0.
 
     [bookmark: pgfId-3765633]Device
 
     [bookmark: pgfId-3765635]The device that generated the discovery event containing the application detail.
 
     [bookmark: pgfId-3765638]Curr[bookmark: marker-3765637]ent User
 
     [bookmark: pgfId-3765640]The user identity (username) of the currently logged in user on the host. 
 
     [bookmark: pgfId-3765641]Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.
 
     [bookmark: pgfId-3765643]Count
 
     [bookmark: pgfId-3765645]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-2559033][bookmark: 26227]Searching for [bookmark: marker-2415329]Application Details
 
     [bookmark: pgfId-3548626]License: FireSIGHT
 
     [bookmark: pgfId-3767010]You can search for hosts that are running specific clients, application protocols, or web applications. You may want to create searches customized for your network environment, then save them to reuse later. 
 
     [bookmark: pgfId-3767089]General Search Syntax
 
     [bookmark: pgfId-3767011]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3766260]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3932773]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3932774]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3932775] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3932776] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3932777] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3932778]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3766262]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3766263]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3766264]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3766265]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3766269]Use the device field to search for specific devices as well as devices in groups, stacks, or clusters. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
      	 [bookmark: pgfId-3946869]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3766270]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-2321627]To search for application details:
 
     [bookmark: pgfId-3561212]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3561627]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3561628]The Search page appears.
 
     [bookmark: pgfId-3561629]Step 2 Select Application Details from the table drop-down list.
 
     [bookmark: pgfId-3561630]The page updates with the appropriate constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-2321635]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2321639]Step 3 Enter your search criteria in the appropriate fields. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3503560]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3503565]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2321647]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3933130]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3933131]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3933132]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3933133]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-2321648]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-2955126]Your search results appear in the default application details workflow. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892373]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2296863][bookmark: 44724]Working with Vulnerabi[bookmark: marker-2415330]lities
 
    [bookmark: pgfId-3548650]License: FireSIGHT
 
    [bookmark: pgfId-2323231]The FireSIGHT System includes its own vulnerability tracking database which is used, in conjunction with the system’s fingerprinting capability, to identify the vulnerabilities associated with the hosts on your network.
 
    [bookmark: pgfId-2323235]The operating systems, servers, and clients running on your hosts have different sets of associated vulnerabilities. You can deactivate vulnerabilities for a host after you patch the host or otherwise judge it immune to a vulnerability. You can use the Defense Center to track and review the vulnerabilities for each host. 
 
    [bookmark: pgfId-3633371]Note that vulnerabilities for vendorless and versionless servers are not mapped unless the applications protocols used by the servers are mapped in the system policy. Vulnerabilities for vendorless and versionless clients cannot be mapped. For more information, see Mapping Vulnerabilities for Servers.
 
    [bookmark: pgfId-2310533]For more information, see:
 
     
     	 [bookmark: pgfId-2322449]Viewing Vulnerabilities
 
     	 [bookmark: pgfId-2555135]Understanding the Vulnerabilities Table
 
     	 [bookmark: pgfId-2337142]Deactivating Vulnerabilities
 
     	 [bookmark: pgfId-2322462]Searching for Vulnerabilities
 
    
 
     
      [bookmark: pgfId-2980857][bookmark: 69503]Viewing Vulner[bookmark: marker-2980855]abilities
 
     [bookmark: pgfId-3548666]License: FireSIGHT
 
     [bookmark: pgfId-2337019]You can use the Defense Center to view a table of vulnerabilities. Then, you can manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-2337571]The page you see when you access vulnerabilities differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of vulnerabilities. The table view contains a row for each vulnerability in the database, regardless of whether any of your detected hosts exhibit the vulnerabilities. The second page of the predefined workflow contains a row for each vulnerability (that you have not deactivated) that applies to detected hosts on your network. The predefined workflow terminates in a vulnerability detail view, which contains a detailed description for every vulnerability that meets your constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-2337578]Tip If you want to see the vulnerabilities that apply to a single host or set of hosts, perform a search for vulnerabilities, specifying an IP address or range of IP addresses for the hosts. For more information on searching for vulnerabilities, see Searching for Vulnerabilities.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2337579]You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
     [bookmark: pgfId-2322232]The following table describes some of the specific actions you can perform on an vulnerabilities workflow page. You can also perform the tasks described in the Common Discovery Event Actions table.
 
     [bookmark: pgfId-2322266]
 
      
      Viewing Vulnerability Details 
      
 
       
        
        [bookmark: pgfId-2322359]Table 50-11 [bookmark: 26940]Vulnerability Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-2322363]To... 
          
  
         	 
           
           [bookmark: pgfId-2322365]You can... 
          
  
        
 
         
         	[bookmark: pgfId-2322367]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-2322371]find more information in Understanding the Vulnerabilities Table.
  
        
 
         
         	[bookmark: pgfId-3634167]view the vulnerability details for a vulnerability
  ) in the SVID column. Alternatively, constrain on the vulnerability ID and drill down to the vulnerability details page. For more information, see . 
        
 
         
         	[bookmark: pgfId-2332486]deactivate selected vulnerabilities so they are no longer used for intrusion impact correlation for currently vulnerable hosts
  
         	[bookmark: pgfId-2332502]find more information in Deactivating Vulnerabilities.
  
        
 
         
         	[bookmark: pgfId-3822399]view the full text of a vulnerability title
  
         	[bookmark: pgfId-3822401]right-click the title and select Show Full Text. 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2322267]To view vulnerabilities:
 
     [bookmark: pgfId-3561227]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2322271]Step 1 Select Analysis > Vulnerabilities > Vulnerabilities.
 
     [bookmark: pgfId-3553683]The first page of the default vulnerabilities workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-2953490]Tip If you are using a custom workflow that does not include the table view of vulnerabilities, click (switch workflow), then select Vulnerabilities.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3892388]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2555172][bookmark: 42244]Understanding the Vuln[bookmark: marker-3015281]erabilities Table
 
     [bookmark: pgfId-3548694]License: FireSIGHT
 
     [bookmark: pgfId-3549128]The FireSIGHT System includes its own vulnerability tracking database which is used, in conjunction with the system’s fingerprinting capability, to identify the vulnerabilities associated with the hosts on your network.
 
     [bookmark: pgfId-3549129]The operating systems, servers, and clients running on your hosts have different sets of associated vulnerabilities. You can deactivate vulnerabilities for a host after you patch the host or otherwise judge it immune to a vulnerability. You can use the Defense Center to track and review the vulnerabilities for each host. 
 
     [bookmark: pgfId-2555190]For more information on vulnerabilities, see Working with the Vulnerabilities Network Map and Working with Vulnerabilities in the Host Profile.
 
     [bookmark: pgfId-2555197]Descriptions of the fields in the vulnerabilities table follow.
 
     [bookmark: pgfId-3766694][bookmark: marker-3766693]SVID
 
     [bookmark: pgfId-3766699]The Cisco vulnerability identification number that the system uses to track vulnerabilities.
 ) to access the vulnerability details for the SVID. See 
     Viewing Vulnerability Details for more information. 
     
 
     [bookmark: pgfId-3766702][bookmark: marker-3766701]Bugtraq ID
 
     [bookmark: pgfId-3766704]The identification number associated with the vulnerability in the Bugtraq database. (http://www.securityfocus.com/bid/)
 
     [bookmark: pgfId-3766708][bookmark: marker-3766707]Snort ID
 
     [bookmark: pgfId-3766710]The identification number associated with the vulnerability in the Snort ID (SID) database. That is, if an intrusion rule can detect network traffic that exploits a particular vulnerability, that vulnerability is associated with the intrusion rule’s SID. 
 
     [bookmark: pgfId-3766711]Note that a vulnerability can be associated with more than one SID (or no SIDs at all). If a vulnerability is associated with more than one SID, the vulnerabilities table includes a row for each SID.
 
     [bookmark: pgfId-3766713]Title
 
     [bookmark: pgfId-3766715]The title of the vulnerability.
 
     [bookmark: pgfId-3766717]IP Address
 
     [bookmark: pgfId-3766719]The IP address associated with the host affected by the vulnerability.
 
     [bookmark: pgfId-3766722][bookmark: marker-3766721]Date Published
 
     [bookmark: pgfId-3766724]The date the vulnerability was published.
 
     [bookmark: pgfId-3766726]Vulnerability Impact
 
     [bookmark: pgfId-3766728]Displays the severity assigned to the vulnerability in the Bugtraq database on a scale of 0 to 10, with 10 being the most severe. The vulnerability impact is determined by the writer of the Bugtraq entry based on his or her best judgment and guided by SANS Critical Vulnerability Analysis (CVA) criteria.
 
     [bookmark: pgfId-3766731][bookmark: marker-3766730]Remote
 
     [bookmark: pgfId-3766733]Indicates whether the vulnerability is remotely exploitable.
 
     [bookmark: pgfId-3766736][bookmark: marker-3766735]Available Exploits
 
     [bookmark: pgfId-3766738]Indicates whether there are known exploits for the vulnerability.
 
     [bookmark: pgfId-3766740]Description
 
     [bookmark: pgfId-3766742]A brief description of the vulnerability.
 
     [bookmark: pgfId-3766744]Technical Description
 
     [bookmark: pgfId-3766746]A detailed technical description of the vulnerability.
 
     [bookmark: pgfId-3766748]Solution
 
     [bookmark: pgfId-3766750]Information about repairing the vulnerability.
 
     [bookmark: pgfId-3766752]Count
 
     [bookmark: pgfId-3766754]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-2559158][bookmark: 13153]Deactivating Vulner[bookmark: marker-2415332]abilities
 
     [bookmark: pgfId-3548714]License: FireSIGHT
 
     [bookmark: pgfId-2335353]Deactivate a vulnerability after you patch the hosts on your network or otherwise judge them immune. Deactivated vulnerabilities are not used for intrusion impact correlation. Note that if the system discovers a new host that is affected by that vulnerability, the vulnerability is considered valid (and is not automatically deactivated) for that host.
 
     [bookmark: pgfId-2372713]You can deactivate vulnerabilities within the vulnerabilities workflow only on a workflow page that shows vulnerabilities for specific hosts on your network, that is:
 
      
      	 [bookmark: pgfId-2335663]on the second page of the default vulnerabilities workflow,  Vulnerabilities on the Network , which shows only the vulnerabilities that apply to the hosts on your network
 
      	 [bookmark: pgfId-2335685]on any page in a vulnerabilities workflow, custom or predefined, that you constrained based on IP address using a search.
 
     
 
     [bookmark: pgfId-2335778]Deactivating a vulnerability within a vulnerabilities workflow that is not constrained on IP addresses deactivates the vulnerability for all detected hosts on your network. To deactivate a vulnerability for a single host, you have three options:
 
      
      	 [bookmark: pgfId-2335825]Use the network map.
 
     
 
     [bookmark: pgfId-2335857]For more information, see Working with the Vulnerabilities Network Map.
 
      
      	 [bookmark: pgfId-2335829]Use the host’s host profile.
 
     
 
     [bookmark: pgfId-2335877]For more information, see Setting Vulnerabilities for Individual Hosts.
 
      
      	 [bookmark: pgfId-2335840]Constrain the vulnerabilities workflow based on the IP addresses of the host or hosts for which you want to deactivate vulnerabilities. For hosts with multiple associated IP addresses, this function applies only to the single, selected IP address of that host.
 
     
 
     [bookmark: pgfId-2372835]To constrain the view based on IP address, perform a search for vulnerabilities, specifying an IP address or range of IP addresses for the hosts for which you want to deactivate vulnerabilities. For more information on searching for vulnerabilities, see Searching for Vulnerabilities.
 
     [bookmark: pgfId-2372857]To deactivate vulnerabilities:
 
     [bookmark: pgfId-3561245]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2336023]Step 1 On the Vulnerabilities on the Network page, select the check boxes next to vulnerabilities you want to deactivate, then click Review.
 
     [bookmark: pgfId-3892412]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2309081][bookmark: 85445]Searching for Vulnera[bookmark: marker-2415333]bilities
 
     [bookmark: pgfId-3548730]License: FireSIGHT
 
     [bookmark: pgfId-2336125]You can search for vulnerabilities that affect the hosts on your network. You may want to create searches customized for your network environment, then save them to reuse later. 
 
     [bookmark: pgfId-3767149]General Search Syntax
 
     [bookmark: pgfId-3767150]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3933362]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3933363]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3933364]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3933365] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3933366] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3933367] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3933368]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3933369]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3767154]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3767155]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3767156]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3767160]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3767161]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3767263]Specific Search Criteria for Vulnerabilities
 
     [bookmark: pgfId-3767590]Note the following information specific to searching for vulnerabilities:
 
      
      	 [bookmark: pgfId-3767312]Find Bugtraq ID numbers at  http://www.securityfocus.com/bid . 
 
      	 [bookmark: pgfId-3767332]Enter  TRUE to search for vulnerabilities that are exploited, or  FALSE to exclude such vulnerabilities.
 
     
 
     [bookmark: pgfId-2322620]To search for vulnerabilities:
 
     [bookmark: pgfId-3561274]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3549614]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3549615]The Search page appears.
 
     [bookmark: pgfId-3549616]Step 2 Select Vulnerabilities from the table drop-down list.
 
     [bookmark: pgfId-2322621]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-2385922]Step 3 Enter your search criteria in the appropriate fields. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3918093]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-3918094]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2322640]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3933732]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3933733]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3933734]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3933735]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-2322641]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-2955219]Your search results appear in the default vulnerabilities workflow. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892424]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3443871][bookmark: 73160]Working with Third-Party Vulnerabi[bookmark: marker-3443870]lities
 
    [bookmark: pgfId-3548746]License: FireSIGHT
 
    [bookmark: pgfId-3549911]The FireSIGHT System includes its own vulnerability tracking database which is used, in conjunction with the system’s fingerprinting capability, to identify the vulnerabilities associated with the hosts on your network.
 
    [bookmark: pgfId-3450449]If your organization can write scripts or create command line import files to import network map data from third-party applications, you can import third-party vulnerability data to augment the system’s vulnerability data. For more information, see the FireSIGHT System Host Input API Guide.
 
    [bookmark: pgfId-3552500]To include imported data in impact correlations, you must map third-party vulnerability information to the operating system and application definitions in the database. You cannot map third-party vulnerability information to client definitions.
 
    [bookmark: pgfId-3444131]For more information, see:
 
     
     	 [bookmark: pgfId-3444146]Viewing Third-Party Vulnerabilities
 
     	 [bookmark: pgfId-3444162]Understanding the Third-Party Vulnerabilities Table
 
     	 [bookmark: pgfId-3905217]Searching for Third-Party Vulnerabilities
 
    
 
     
      [bookmark: pgfId-3905238][bookmark: 39302]Viewing Third-Party [bookmark: marker-3905237]Vulnerabilities
 
     [bookmark: pgfId-3548763]License: FireSIGHT
 
     [bookmark: pgfId-3444219]After you use the host input feature to import third-party vulnerability data, you can use the Defense Center to view a table of third-party vulnerabilities. Then, you can manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-3444445]The page you see when you access third-party vulnerabilities differs depending on the workflow you use. There are two predefined workflows. You can also create a custom workflow that displays only the information that matches your specific needs. For more information, see Creating Custom Workflows.
 
      
      Viewing Vulnerability Details 
      
 
       
        
        [bookmark: pgfId-3444254]Table 50-12 [bookmark: 88055]Third-Party Vulnerability Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3444258]To... 
          
  
         	 
           
           [bookmark: pgfId-3444260]You can... 
          
  
        
 
         
         	[bookmark: pgfId-3444262]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-3444266]find more information in Understanding the Third-Party Vulnerabilities Table.
  
        
 
         
         	[bookmark: pgfId-3446012]view the vulnerability details for a third-party vulnerability
  ) in the SVID column. Alternatively, constrain on the vulnerability ID and drill down to the vulnerability details page. For more information, see . 
        
 
        
      
 
     
 
     [bookmark: pgfId-3444295]To view third-party vulnerabilities:
 
     [bookmark: pgfId-3561292]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3444564]Step 1 Select Analysis > Vulnerabilities > Third-Party Vulnerabilities.
 
     [bookmark: pgfId-3444565]The first page of the default third-party vulnerabilities workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-3444308]Tip If you are using a custom workflow that does not include the table view of third-party vulnerabilities, click (switch workflow), then select Vulnerabilities by Source or Vulnerabilities by IP Address.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3892443]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3443776][bookmark: 90038]Understanding the Third-Party Vuln[bookmark: marker-3443775]erabilities Table
 
     [bookmark: pgfId-3548779]License: FireSIGHT
 
     [bookmark: pgfId-3451280]When you import third-party vulnerability information using the host input feature, the system stores that information in its database. The fields in the third-party vulnerabilities table are described in the following table.
 
     [bookmark: pgfId-3768021]Vulnerability Source
 
     [bookmark: pgfId-3768023]The source of the third-party vulnerabilities, for example, QualysGuard or NeXpose.
 
     [bookmark: pgfId-3768025]Vulnerability ID
 
     [bookmark: pgfId-3768027]The ID number associated with the vulnerability for its source.
 
     [bookmark: pgfId-3768029]IP Address
 
     [bookmark: pgfId-3768031]The IP address associated with the host affected by the vulnerability.
 
     [bookmark: pgfId-3768033]Port
 
     [bookmark: pgfId-3768035]A port number, if the vulnerability is associated with a server running on a specific port.
 
     [bookmark: pgfId-3768037]Bugtraq ID
 
     [bookmark: pgfId-3768039]The identification number associated with the vulnerability in the Bugtraq database. (http://www.securityfocus.com/bid/)
 
     [bookmark: pgfId-3768042]CVE ID
 
     [bookmark: pgfId-3768044]The identification number associated with the vulnerability in MITRE’s Common Vulnerabilities and Exposures (CVE) database (http://www.cve.mitre.org/).
 
     [bookmark: pgfId-3768048][bookmark: marker-3768047]SVID
 
     [bookmark: pgfId-3768054]The legacy vulnerability identification number that the system uses to track vulnerabilities
 ) to access the vulnerability details for the 
     [bookmark: marker-3928534]SVID. See 
     Viewing Vulnerability Details for more information. 
     
 
     [bookmark: pgfId-3768056]Snort ID
 
     [bookmark: pgfId-3768058]The identification number associated with the vulnerability in the Snort ID (SID) database. That is, if an intrusion rule can detect network traffic that exploits a particular vulnerability, that vulnerability is associated with the intrusion rule’s SID.
 
     [bookmark: pgfId-3768059]Note that a vulnerability can be associated with more than one SID (or no SIDs at all). If a vulnerability is associated with more than one SID, the vulnerabilities table includes a row for each SID.
 
     [bookmark: pgfId-3768061]Title
 
     [bookmark: pgfId-3768063]The title of the vulnerability.
 
     [bookmark: pgfId-3768065]Description
 
     [bookmark: pgfId-3768067]A brief description of the vulnerability.
 
     [bookmark: pgfId-3768069]Count
 
     [bookmark: pgfId-3768071]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-3451364][bookmark: 28217]Searching for Third-Party Vulnera[bookmark: marker-3443838]bilities
 
     [bookmark: pgfId-3548803]License: FireSIGHT
 
     [bookmark: pgfId-3445033]You can search for third-party vulnerabilities that affect the hosts on your network. You may want to create searches customized for your network environment, then save them to reuse later. 
 
     [bookmark: pgfId-3768487]General Search Syntax
 
     [bookmark: pgfId-3768488]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3768489]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3933859]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3933860]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3933861] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3933862] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3933863] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3933864]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3768491]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3768492]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3768493]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3768494]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3768498]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3768499]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3768503]Specific Search Criteria for Vulnerabilities
 
     [bookmark: pgfId-3768504]Note the following information specific to searching for vulnerabilities:
 
      
      	 [bookmark: pgfId-3768506]Find Bugtraq ID numbers at  http://www.securityfocus.com/bid .
 
      	 [bookmark: pgfId-3768507]Enter  TRUE to search for vulnerabilities that are exploited, or  FALSE to exclude such vulnerabilities.
 
     
 
     [bookmark: pgfId-3445115]To search for third-party vulnerabilities:
 
     [bookmark: pgfId-3561373]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3561374]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3561375]The Search page appears.
 
     [bookmark: pgfId-3561376]Step 2 Select Third-Party Vulnerabilities from the table drop-down list.
 
     [bookmark: pgfId-3561377]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-3445132]Step 3 Enter your search criteria in the appropriate fields. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3503623]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-3550502]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3445141]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3934143]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3934144]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3934145]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3934146]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-3445142]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-3445143]Your search results appear in the default third-party vulnerabilities workflow. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892479]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3574555][bookmark: 75218]Working with Us[bookmark: marker-3574554]ers
 
    [bookmark: pgfId-3574559]License: FireSIGHT
 
    [bookmark: pgfId-3574560]When either an Active Directory Agent or a managed device detects a user login for a user who is not already in the database, the user is added to the database, unless you have specifically restricted that login type (see Restricting User Logging).
 
     
      
    
 
    
 
    [bookmark: pgfId-3574564]Note Although the system detects SMTP logins, the system does not record them unless there is already a user with a matching email address in the database; users are not added to the database based on SMTP logins.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-3574569]Table 50-13 Login Types and User Data Stored 
 
       
       
        
        	 
          
          [bookmark: pgfId-3574573]Login Type 
         
  
        	 
          
          [bookmark: pgfId-3574575]User Data Stored 
         
  
       
 
        
        	[bookmark: pgfId-3574577]LDAP
AIM
Oracle
SIP
HTTP
FTP
MDNS
  
        	 
          
          	 [bookmark: pgfId-3574579]username
 
          	 [bookmark: pgfId-3574580]current IP address
 
          	 [bookmark: pgfId-3574581]login type ( aim ,  ldap ,  oracle ,  sip ,  http ,  ftp , or  mdns )
 
         
  
       
 
        
        	[bookmark: pgfId-3574583]POP3
IMAP
  
        	 
          
          	 [bookmark: pgfId-3574585]username
 
          	 [bookmark: pgfId-3574586]current IP address
 
          	 [bookmark: pgfId-3574587]email address
 
          	 [bookmark: pgfId-3574588]login type ( pop3 or  imap )
 
         
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3574596]If you configured Defense Center-LDAP server connections, the Defense Center queries the LDAP servers every five minutes and obtains metadata for the new users in the user database. At the same time, the Defense Center also queries the LDAP servers for updated information on users whose records in the Defense Center database are more than 12 hours old. It may take five to ten minutes for the Defense Center database to update with user metadata after the system detects a new user login. From the LDAP servers, the Defense Center obtains the following information and metadata about each user:
 
     
     	 [bookmark: pgfId-3574609]LDAP username
 
     	 [bookmark: pgfId-3574610]first and last names
 
     	 [bookmark: pgfId-3574611]email address
 
     	 [bookmark: pgfId-3574612]department
 
     	 [bookmark: pgfId-3574613]telephone number
 
    
 
    [bookmark: pgfId-3574617]The number of users the Defense Center can store in its database depends on your FireSIGHT license. Note that AIM, Oracle, and SIP logins create duplicate user records because they are not associated with any of the user metadata that the system obtains from LDAP servers. To prevent overuse of user count because of duplicate user records from these protocols, disable logging of the protocols in the network discovery policy. For more information, see Restricting User Logging.
 
    [bookmark: pgfId-3574621]You can search, view, and delete users from the database; you can also purge all users from the database. For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3574625]Viewing Users
 
     	 [bookmark: pgfId-3574629]Understanding the Users Table
 
     	 [bookmark: pgfId-3574633]Understanding User Details and Host History
 
     	 [bookmark: pgfId-3574637]Searching for Users
 
    
 
     
      [bookmark: pgfId-3574642][bookmark: 37591]Viewing Us[bookmark: marker-3574641]ers
 
     [bookmark: pgfId-3574648]License: FireSIGHT
 
     [bookmark: pgfId-3574649]You can view a table of users, and then manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-3574650]The page you see when you access users differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of users that lists all detected users, and terminates in a user details page. The user details page provides information on every user that meets your constraints.
 
     [bookmark: pgfId-3574651]You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
     [bookmark: pgfId-3574655]For more information about the contents of the columns in the table, see Understanding the Users Table.The following table, see describes some of the specific actions you can perform on an users workflow page. You can also perform the actions in the Common Discovery Event Actions table.
 
     [bookmark: pgfId-3574748]To view users:
 
     [bookmark: pgfId-3574749]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3574750]Step 1 Select Analysis > Users > Users.
 
     [bookmark: pgfId-3574751]The first page of the default users workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-3574755]Tip If you are using a custom workflow that does not include the table view of users, click (switch workflow), then select Users.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3892508]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3574758][bookmark: 53004]Understanding the Use[bookmark: marker-3574757]rs Table
 
     [bookmark: pgfId-3574762]License: FireSIGHT
 
     [bookmark: pgfId-3574763]When the system discovers a user, it collects data about that user and stores it in the database. Descriptions of the fields in the users table follow.
 
     [bookmark: pgfId-3769075]User
 
     [bookmark: pgfId-3769077]One of:
 
     [bookmark: pgfId-3769078] – the first name, last name, and username of the user as collected via the optional Defense Center-LDAP server connections
 
     [bookmark: pgfId-3769082] – the username only, if you have not configured Defense Center-LDAP server connections, or for users that the Defense Center cannot correlate with an LDAP record
 
     [bookmark: pgfId-3769092]The Defense Center also displays the protocol used to detect the user.
 
     [bookmark: pgfId-3769093]Note that because unsuccessful AIM login attempts are recorded, the Defense Center can store invalid AIM users (for example, if a user misspelled his or her username).
 
     [bookmark: pgfId-3769098]Current IP
 
     [bookmark: pgfId-3769100]The IP address associated with the host that the user is logged into. This field is blank if another authoritative user logs into the host with the same IP address after the user’s login, unless the user is an authoritative user and the new user is a non-authoritative user. (The system associates the IP address with the last authoritative user that logged in with the host.) For more information on authoritative vs. non-authoritative users, see Users Database.
 
     [bookmark: pgfId-3769105]First Name
 
     [bookmark: pgfId-3769107]The user’s first name, as obtained from the optional Defense Center-LDAP server connections. This field is blank if:
 
     [bookmark: pgfId-3769114] – you have not configured a Defense Center-LDAP server connection
 
     [bookmark: pgfId-3769118] – the Defense Center cannot correlate the user in the Defense Center database with an LDAP record (for example, for users added to the database via an AIM, Oracle, or SIP login)
 
     [bookmark: pgfId-3769122] – there is no first name associated with the user on your LDAP servers
 
     [bookmark: pgfId-3769124]Last Name
 
     [bookmark: pgfId-3769126]The user’s last name, as obtained from the optional Defense Center-LDAP server connections. This field is blank if:
 
     [bookmark: pgfId-3769133] – you have not configured a Defense Center-LDAP server connection
 
     [bookmark: pgfId-3769137] – the Defense Center cannot correlate the user in the Defense Center database with an LDAP record (for example, for users added to the database via an AIM, Oracle, or SIP login)
 
     [bookmark: pgfId-3769141] – there is no last name associated with the user on your LDAP servers
 
     [bookmark: pgfId-3769143]E-Mail
 
     [bookmark: pgfId-3769145]The user’s email address. This field is blank if:
 
     [bookmark: pgfId-3769146] – the user was added to the database via an AIM login
 
     [bookmark: pgfId-3769147] – the user was added to the database via an LDAP login and there is no email address associated with the user on your LDAP servers
 
     [bookmark: pgfId-3769149]Department
 
     [bookmark: pgfId-3769151]The user’s department, as obtained from the optional Defense Center-LDAP server connections. If there is no department explicitly associated with the user on your LDAP servers, the department is listed as whatever default group the server assigns. For example, on Active Directory, this is Users (ad). This field is blank if:
 
     [bookmark: pgfId-3769158] – you have not configured a Defense Center-LDAP server connection
 
     [bookmark: pgfId-3769162] – the Defense Center cannot correlate the user in the Defense Center database with an LDAP record (for example, for users added to the database via an AIM, Oracle, or SIP login)
 
     [bookmark: pgfId-3769167]Phone
 
     [bookmark: pgfId-3769169]The user’s telephone number, as obtained from the optional Defense Center-LDAP server connections. This field is blank if:
 
     [bookmark: pgfId-3769176] – you have not configured a Defense Center-LDAP server connection
 
     [bookmark: pgfId-3769180] – the Defense Center cannot correlate the user in the Defense Center database with an LDAP record (for example, for users added to the database via an AIM, Oracle, or SIP login)
 
     [bookmark: pgfId-3769184] – there is no telephone number associated with the user on your LDAP servers
 
     [bookmark: pgfId-3769186]User Type
 
     [bookmark: pgfId-3769188]The protocol used to detect the user. For example, for users added to the database when detects a POP3 login, the user type is pop3.
 
     [bookmark: pgfId-3769190]Count
 
     [bookmark: pgfId-3769192]The number of users that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-3574905][bookmark: 36493]Understanding User [bookmark: marker-3574904]Details and Host History
 
     [bookmark: pgfId-3574909]License: FireSIGHT
 
     [bookmark: pgfId-3574911]From any event view that associates user identity data with other kinds of events, as well as from a table view of users, you can display the User Identity pop-up window to learn more about a specific user. User information also appears in the terminating page for users workflows.
 
     [bookmark: pgfId-3574916]The user data you see is the same as you would see in the table view of users; for more information, see Understanding the Users Table.
 
     [bookmark: pgfId-3574920]The host history provides a graphic representation of the last twenty-four hours of the user’s activity. A list of IP addresses of the hosts that the user logged into and logged off of approximates login and logout times with bar graphs. A typical user might log on to and off of multiple hosts in the course of a day. For example, periodic automated logins to a mail server would display as multiple short sessions, while longer logins (such as during working hours) display longer sessions.
 
     [bookmark: pgfId-3659144]Note that when a non-authoritative user login to a host is detected, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user login is detected for that host, only another authoritative user login changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control. If you configure capture of failed logins in the network discovery policy, the host history also includes hosts where the user failed to log in.
 
     [bookmark: pgfId-3574921]The data used to generate the host history is stored in the user history database, which by default stores 10 million user login events. If you do not see any data in the host history for a particular user, either that user is inactive, or you may need to increase the database limit. For more information, see Configuring Database Event Limits. 
 
     [bookmark: pgfId-3574925]To view user details and host history:
 
     [bookmark: pgfId-3574926]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3574927]Step 1 You have two options:
 
      
       
       	 [bookmark: pgfId-3574931]In any event view that lists users, click the user icon (
 
      
 
      [image: ] ) that appears next to a user identity. 
     
 
      
       
       	 [bookmark: pgfId-3574932]In any users workflow, click the Users terminating page.
 
      
 
     
 
     [bookmark: pgfId-3574933]User details appear.
 
    
 
     
      [bookmark: pgfId-3574937][bookmark: 13397]Searc[bookmark: marker-3574935]hing for Users
 
     [bookmark: pgfId-3574942]License: FireSIGHT
 
     [bookmark: pgfId-3574944]You can search for specific users. You may want to create searches customized for your network environment, then save them to reuse later. 
 
     [bookmark: pgfId-3769623]General Search Syntax
 
     [bookmark: pgfId-3769624]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3769625]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3934212]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3934213]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3934214] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3934215] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3934216] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3934217]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3769627]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3769628]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3769629]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3769630]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3769634]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3769635]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3769697]Specific User Search Criteria
 
     [bookmark: pgfId-3769738]For User Type, valid search criteria are ldap, pop3, imap, oracle, sip, http, ftp, mdns, and aim; because users are not added to the database based on SMTP logins, entering smtp will not return any results.
 
     [bookmark: pgfId-3575008]To search for users:
 
     [bookmark: pgfId-3575009]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3612703]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3612704]The Search page appears.
 
     [bookmark: pgfId-3612705]Step 2 Select Users from the table drop-down list.
 
     [bookmark: pgfId-3575011]The Users search page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-3575016]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3575021]Step 3 Enter your search criteria in the appropriate fields. 
 
     [bookmark: pgfId-3934289]If you enter criteria for multiple fields, the search returns only the records that match search criteria specified for all fields.
 
     [bookmark: pgfId-3575023]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users
 
      
       
     
 
     
 
     [bookmark: pgfId-3575024]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3575025]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3934400]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3934401]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3934402]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3934403]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-3575026]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-3575027]Your search results appear in the default users workflow. To use a different workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892536]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3575035][bookmark: 13786]Working with User Activi[bookmark: marker-3575034]ty
 
    [bookmark: pgfId-3575039]License: FireSIGHT
 
    [bookmark: pgfId-3575043]The FireSIGHT System generates events that communicate the details of user activity on your network. Descriptions of the four types of user activity follow.
 
    [bookmark: pgfId-3769921]New User Identity
 
    [bookmark: pgfId-3769923]This event is generated when the system detects a user login for a user that is not in the database.
 
    [bookmark: pgfId-3769925]User Login
 
    [bookmark: pgfId-3769927]This event is generated when any of the following occur:
 
    [bookmark: pgfId-3769928] – an Active Directory Agent that you installed on an Active Directory server detects an LDAP login
 
    [bookmark: pgfId-3769929] – a managed device detects an LDAP, POP3, IMAP, SMTP, AIM, Oracle, FTP, HTTP, MDNS or SIP login
 
    [bookmark: pgfId-3769930] – There are several points to keep in mind regarding user login events:
 
    [bookmark: pgfId-3769931] – SMTP logins are not recorded unless there is already a user with a matching email address in the database. 
 
    [bookmark: pgfId-3769932] – Failed logins are only for LDAP, IMAP, FTP, and POP3, and only when detected in traffic. Users are not added to the detected users database as a result of a failed login, but the activity is optionally recorded in the user activity database, based on the user logging configuration in the network discovery policy.
 
    [bookmark: pgfId-3769933] – A user login is not recorded if you have specifically restricted its login type; see Restricting User Logging.
 
    [bookmark: pgfId-3769937]Note that when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user. In addition, when a non-authoritative user is the current user on a host, that user still cannot be used for user control.
 
    [bookmark: pgfId-3769939]Delete User Identity
 
    [bookmark: pgfId-3769941]This event is generated when you manually delete a user from the database.
 
    [bookmark: pgfId-3769943]User Identity Dropped: User Limit Reached
 
    [bookmark: pgfId-3769945]This event is generated when the system detects a user that is not in the database, but cannot add the user because you have reached the maximum number of users in the database as determined by your FireSIGHT license.
 
    [bookmark: pgfId-3769952]The total number of detected users the Defense Center can store depends on your FireSIGHT license. After you reach the licensed limit, in most cases the system stops adding new users to the database. To add new users, you must either manually delete old or inactive users from the database, or purge all users from the database.
 
    [bookmark: pgfId-3769956]However, the system favors authoritative users. If you have reached the limit and the system detects a login for a previously undetected authoritative user, the system deletes the non-authoritative user who has remained inactive for the longest time, and replaces it with the new authoritative user.
 
    [bookmark: pgfId-3575086]When the system detects user activity, it is logged to the database. You can view, search, and delete user activity; you can also purge all user activity from the database.
 
    [bookmark: pgfId-3575090]Whenever possible the FireSIGHT System correlates user activity with other types of events. For example, intrusion events can tell you the users who were logged into the source and destination hosts at the time of the event. This can tell you who owns the host that was targeted by an attack, or who initiated an internal attack or portscan. 
 
    [bookmark: pgfId-3575091]You can also use user activity in correlation rules. Based on the type of user activity as well as other criteria that you specify, you can build correlation rules that, when used in a correlation policy, launch remediations and alert responses when network traffic meets your criteria. For more information on user activity, see Understanding User Data Collection.
 
    [bookmark: pgfId-3575095]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3575099]Viewing User Activity Events
 
     	 [bookmark: pgfId-3575103]Understanding the User Activity Table
 
     	 [bookmark: pgfId-3575107]Searching for User Activity
 
    
 
     
      [bookmark: pgfId-3575112][bookmark: 59348]Viewing User Activi[bookmark: marker-3575111]ty Events
 
     [bookmark: pgfId-3575118]License: FireSIGHT
 
     [bookmark: pgfId-3575119]You can view a table of user activity, and then manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-3575120]The page you see when you access user activity differs depending on the workflow you use. You can use the predefined workflow, which includes the table view of user activity and terminates in a user details page, which contains user details for every user that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
     [bookmark: pgfId-3770143]For more information about the contents of the columns in the table, see Understanding the User Activity Table.The following table, see describes some of the specific actions you can perform on an user activity workflow page. You can also perform the actions in the Common Discovery Event Actions table.
 
     [bookmark: pgfId-3575225]To view user activity:
 
     [bookmark: pgfId-3575226]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3575227]Step 1 Select Analysis > Users > User Activity.
 
     [bookmark: pgfId-3575228]The first page of the default user activity workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-3575235]Tip If you are using a custom workflow that does not include the table view of user activity, click (switch workflow), then select User Activity.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3892548]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3575238][bookmark: 39382]Understanding the User Activi[bookmark: marker-3575237]ty Table
 
     [bookmark: pgfId-3575242]License: FireSIGHT
 
     [bookmark: pgfId-3575243]When the system detects user activity, it is logged to the database. Descriptions of the fields in the users table follow.
 
     [bookmark: pgfId-3770277]Time
 
     [bookmark: pgfId-3770279]The time that the system detected the user activity.
 
     [bookmark: pgfId-3770281]Event
 
     [bookmark: pgfId-3770285]The user activity type. For more information, see Working with User Activity.
 
     [bookmark: pgfId-3770288]User
 
     [bookmark: pgfId-3770290]The user associated with the activity. At a minimum, this field contains a username and the protocol used to detect the user. If there is LDAP metadata on the user, this field may also contain the first name and last name of the user.
 
     [bookmark: pgfId-3770292]User Type
 
     [bookmark: pgfId-3770294]The protocol used to detect the user. For example, for users added to the database when the system detects a POP3 login, the user type is pop3.
 
     [bookmark: pgfId-3770296]IP Address
 
     [bookmark: pgfId-3770298]For User Login activity, the IP address involved in the login, which can be an IP address of the user’s host (for LDAP, POP3, IMAP, FTP, HTTP, MDNS, and AIM logins), the server (for SMTP and Oracle logins), or the session originator (for SIP logins).
 
     [bookmark: pgfId-3770299]Note that an associated IP address does not mean the user is the current user for that IP address; when a non-authoritative user logs into a host, that login is recorded in the user and host history. If no authoritative user is associated with the host, a non-authoritative user can be the current user for the host. However, after an authoritative user logs into the host, only a login by another authoritative user changes the current user.
 
     [bookmark: pgfId-3770300]For other types of user activity, this field is blank.
 
     [bookmark: pgfId-3770302]Description
 
     [bookmark: pgfId-3770304]For Delete User Identity and User Identity Dropped activity, the username of the user who was deleted from the database or failed to be added to the database. For logins to network resources, network login is displayed. For other types of user activity, this field is blank.
 
     [bookmark: pgfId-3770306]Device
 
     [bookmark: pgfId-3770308]For user activity detected by a managed device, the name of the device. For other types of user activity, the managing Defense Center.
 
     [bookmark: pgfId-3770313]Count
 
     [bookmark: pgfId-3770315]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
    
 
     
      [bookmark: pgfId-3575297][bookmark: 10203]Search[bookmark: marker-3575295]ing for User Activity
 
     [bookmark: pgfId-3575302]License: FireSIGHT
 
     [bookmark: pgfId-3575304]You can search for specific user activity. You may want to create searches customized for your network environment, then save them to reuse later. 
 
     [bookmark: pgfId-3770609]General Search Syntax
 
     [bookmark: pgfId-3770610]The system displays examples of valid syntax next to each search field. When entering search criteria, keep the following points in mind:
 
      
      	 [bookmark: pgfId-3770611]All fields accept negation ( ! ).
 
      	 [bookmark: pgfId-3934460]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
      	 [bookmark: pgfId-3934461]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
     
 
     [bookmark: pgfId-3934462] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-3934463] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-3934464] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
      	 [bookmark: pgfId-3934465]Searches return only records that match the search criteria specified for all fields.
 
      	 [bookmark: pgfId-3770613]Many fields accept one or more asterisks ( * ) as wild cards.
 
      	 [bookmark: pgfId-3770614]For some fields, you can specify  n/a or  blank in the field to identify events where information is not available for that field; use  !n/a or  !blank to identify the events where that field is populated.
 
      	 [bookmark: pgfId-3770615]Most fields are case-insensitive.
 
      	 [bookmark: pgfId-3770616]IP addresses may be specified using CIDR notation. For information on entering IPv4 and IPv6 addresses in the FireSIGHT System, see IP Address Conventions.
 
      	 [bookmark: pgfId-3947974]Use the device field to search for specific devices as well as devices in groups, stacks, or clusters. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
      	 [bookmark: pgfId-3770620]Click the add object icon (
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3770621]For detailed information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-3575368]To search for user activity:
 
     [bookmark: pgfId-3575369]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-3575370]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-3575371]The Search page appears.
 
     [bookmark: pgfId-3575372]Step 2 Select User Activity from the table drop-down menu.
 
     [bookmark: pgfId-3575373]The User Activity search page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-3575378]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3575383]Step 3 Enter your search criteria in the appropriate fields. 
 ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-3575385]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3575386]Tip If you want to save a search as a restriction for custom user roles with restricted privileges, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3575387]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3934587]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3934588]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3934589]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3934590]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-3575388]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-3575389]Your search results appear in the default user activity workflow, constrained by the current time range. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3892567]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3443759]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1903167][bookmark: 71635]Configurin[bookmark: marker-2588338]g Correlation Policies[bookmark: marker-2275258] and Rules 
      
      
 
     
 
 
    [bookmark: pgfId-3277946]You can use the FireSIGHT System’s correlation feature to build correlation policies, which are populated with correlation rules and compliance white lists, and that let you respond in real time to threats to your network. A correlation policy violation occurs when the activity on your network triggers either a correlation rule or white list.
 
    [bookmark: pgfId-3043046]A correlation rule triggers when a specific event generated by the FireSIGHT System either meets criteria that you specify, or when your network traffic deviates from your normal network traffic pattern as characterized in an existing traffic profile.
 
    [bookmark: pgfId-3042217]Compliance white lists, on the other hand, trigger when the system determines that a host on your network is running a prohibited operating system, client application (or client), application protocol, or protocol.
 
    [bookmark: pgfId-3105765]You can configure the FireSIGHT System to initiate responses to policy violations. Responses include simple alerts as well as various remediations (such as scanning a host). You can group responses so that the system launches multiple responses for each policy violation.
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3106038]This chapter focuses on creating correlation rules, using those rules in policies, associating responses and response groups with those rules, and analyzing correlation events. For more information, see:
 
     
     	 [bookmark: pgfId-3106042]Creating Rules for Correlation Policies
 
     	 [bookmark: pgfId-3106046]Managing Rules for Correlation Policies
 
     	 [bookmark: pgfId-3106050]Grouping Correlation Responses
 
     	 [bookmark: pgfId-3106054]Creating Correlation Policies
 
     	 [bookmark: pgfId-3106058]Managing Correlation Policies
 
     	 [bookmark: pgfId-3106062]Working with Correlation Events
 
    
 
    [bookmark: pgfId-3105853]For information on creating compliance white lists and correlation responses (alerts and remediations), see:
 
     
     	 [bookmark: pgfId-3105900]Using the FireSIGHT System as a Compliance Tool 
 
     	 [bookmark: pgfId-3105926]Working with Alert Responses.
 
     	 [bookmark: pgfId-3105956]Configuring Correlation Policies and Rules.
 
    
 
   
 
    
     [bookmark: pgfId-1903222][bookmark: 34589]Creating Rules for[bookmark: marker-2276576] Correlation Policies
 
    [bookmark: pgfId-3286318]License: FireSIGHT, Protection, URL Filtering, or Malware
 
    [bookmark: pgfId-3286319]Supported Devices: feature dependent
 
    [bookmark: pgfId-3286320]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-2163751]Before you create a correlation policy, you should create correlation rules or compliance white lists (or both) to populate it.
 
     
      
    
 
    
 
    [bookmark: pgfId-2215078]Note This section describes how to create correlation rules. For information on creating compliance white lists, see Creating Compliance White Lists.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3044123]A correlation rule triggers (and generates a correlation event) when your network traffic meets criteria that you specify. When you create correlation rules, you can use simple conditions or you can create more elaborate constructs by combining and nesting conditions and constraints.
 
    [bookmark: pgfId-3044089]You can further add to correlation rules in the following ways:
 
     
     	 [bookmark: pgfId-3073579]Add a  host profile qualification to constrain the rule using information from the host profile of a host involved in the triggering event.
 
     	 [bookmark: pgfId-2812827]Add a  connection tracker to a correlation rule so that after the rule’s initial criteria are met, the system begins tracking certain connections. Then, a correlation event is generated only if the tracked connections meet additional criteria.
 
     	 [bookmark: pgfId-3363735]Add a  user qualification to a correlation rule to track certain users or groups of users. For example, you could constrain a correlation rule so that it triggers only when the identity of the source or destination user is a certain user or, for example, one from the marketing department.
 
     	 [bookmark: pgfId-3533342]Add  snooze periods and inactive periods . When a correlation rule triggers once, a snooze period causes that rule not to trigger again for a specified interval, even if the rule is violated again during the interval. After the snooze period has elapsed, the rule can trigger again (and start a new snooze period). During inactive periods, the correlation rule does not trigger.
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-3363719] 
     Caution Evaluating complex correlation rules that trigger on frequently occurring events can degrade Defense Center performance. For example, a multi-condition rule that the Defense Center must evaluate against every connection logged by the system can cause resource overload. 
      
      
 
     
 
    
 
     
     [bookmark: pgfId-3171529]To... 
    
 
     
     [bookmark: pgfId-3171531]You need this license... 
    
 
    [bookmark: pgfId-3171533]trigger a correlation rule on an intrusion event or Security Intelligence event
 
    [bookmark: pgfId-3171538]Protection
 
    [bookmark: pgfId-3171540]trigger a correlation rule on a discovery event, host input event, geolocation data, or user activity, or to add a host profile or user qualification to a correlation rule
 
    [bookmark: pgfId-3171545]FireSIGHT
 
    [bookmark: pgfId-3171547]trigger a correlation rule on a connection event or endpoint-based malware event, or to add a connection tracker to a rule
 
    [bookmark: pgfId-3171549]Any
 
    [bookmark: pgfId-3171551]trigger a correlation rule on a connection event with URL data, or build a connection tracker using URL data
 
    [bookmark: pgfId-3284147]Note that neither Series 2 devices nor the DC500 Defense Center support URL filtering by category or reputation, and Series 2 devices do not support URL filtering by literal URL or URL group.
 
    [bookmark: pgfId-3171553]URL Filtering
 
    [bookmark: pgfId-3283834]trigger a correlation rule on a malware event based on network-based malware data or retrospective network-based malware data
 
    [bookmark: pgfId-3283999]Note that Series 2 and Cisco NGIPS for Blue Coat X-Series devices and the DC500 Defense Center do not support network-based malware protection.
 
    [bookmark: pgfId-3283839]Malware
 
   
 
   [bookmark: pgfId-2409865]Due to memory limitations, some device models perform URL filtering with a smaller, less granular, set of categories and reputations. For example, if a parent domain's subsites have different URL categories and reputations, some devices may use the parent site's data for all subsites. These devices include the 7100 Family and the following ASA FirePOWER models: ASA 5506-X, ASA 5506H-X, ASA 5506W-X, ASA 5508-X, ASA 5516-X, and the ASA 5525-X. 
 
   [bookmark: pgfId-3533400]For virtual devices, see the installation guide for information on allocating the correct amount of memory to perform category and reputation-based URL filtering.
 
   [bookmark: pgfId-3533347]When you create either correlation rule trigger criteria, host profile qualifications, user qualifications, or connection trackers, the syntax varies but the mechanics remain consistent. For more information, See Understanding Rule Building Mechanics.
 
   [bookmark: pgfId-1903249]To create a correlation rule:
 
   [bookmark: pgfId-2513483]Access: Admin/Discovery Admin
 
   
 
   [bookmark: pgfId-1903250]Step 1 Select Policies > Correlation, then select the Rule Management tab.
 
   [bookmark: pgfId-1903251]The Rule Management page appears.
 
   [bookmark: pgfId-1903256]Step 2 Click Create Rule.
 
   [bookmark: pgfId-1903257]The Create Rule page appears.
 
   [bookmark: pgfId-1903262]Step 3 Provide basic rule information, such as the rule name, description, and group.
 
   [bookmark: pgfId-1903266]See Providing Basic Rule Information.
 
   [bookmark: pgfId-1903267]Step 4 Specify the basic criteria on which you want the rule to trigger.
 
   [bookmark: pgfId-1903271]See Specifying Correlation Rule Trigger Criteria.
 
   [bookmark: pgfId-1903272]Step 5 Optionally, add a host profile qualification to the rule.
 
   [bookmark: pgfId-1903276]See Adding a Host Profile Qualification.
 
   [bookmark: pgfId-1903277]Step 6 Optionally, add a connection tracker to the rule.
 
   [bookmark: pgfId-1903281]See Constraining Correlation Rules Using Connection Data Over Time.
 
   [bookmark: pgfId-2397078]Step 7 Optionally, add a user qualification to the rule.
 
   [bookmark: pgfId-2397091]See Adding a User Qualification.
 
   [bookmark: pgfId-1903282]Step 8 Optionally, add an inactive period or snooze period (or both) to the rule.
 
   [bookmark: pgfId-1903286]See Adding Snooze and Inactive Periods.
 
   [bookmark: pgfId-1903288]Step 9 [bookmark: 82577]Click Save Rule.
 
   [bookmark: pgfId-1903289]The rule is saved. You can now use the rule within correlation policies or within other correlation rules that trigger on the same event type.
 
   [bookmark: pgfId-3413846]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-2385762][bookmark: 20343]Providing Basic Rule Inf[bookmark: marker-2588339]ormation
 
    [bookmark: pgfId-2976764]License: Any
 
    [bookmark: pgfId-2385763]You must give each correlation rule a name and, optionally, a short description. You can also place the rule in a rule group.
 
    [bookmark: pgfId-2385768]To provide basic rule information:
 
    [bookmark: pgfId-2513486]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-2385769]Step 1 Select Policies > Correlation, then select the Rule Management tab.
 
    [bookmark: pgfId-3267224]The Rule Management page appears.
 
    [bookmark: pgfId-3267265]Step 2 Click Create Rule.
 
    [bookmark: pgfId-3267289]The Create Rule page appears.
 
    [bookmark: pgfId-3267337]Step 3 On the Create Rule page, in the Rule Name field, type a name for the rule.
 
    [bookmark: pgfId-2385770]Step 4 In the Rule Description field, type a description for the rule.
 
    [bookmark: pgfId-2385771]Step 5 Optionally, select a group for the rule from the Rule Group drop-down list.
 
    [bookmark: pgfId-2385774]For more information on rule groups, see Managing Rules for Correlation Policies.
 
    [bookmark: pgfId-2385778]Step 6 Continue with the procedure in the next section, Specifying Correlation Rule Trigger Criteria.
 
    [bookmark: pgfId-3413862]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2385783][bookmark: 59131]Specifying Correlation Rule[bookmark: marker-2385782] Trigger Criteria
 
    [bookmark: pgfId-3067367]License: feature dependent
 
    [bookmark: pgfId-3401238]Supported Devices: feature dependent
 
    [bookmark: pgfId-3401242]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-3401243]A simple correlation rule requires only that an event of a certain type occurs; you do not need to provide more specific conditions. For example, correlation rules based on traffic profile changes do not require any conditions at all. In contrast, correlation rules may be complex, with multiple nested conditions. For example, the rule shown in the following graphic comprises criteria that direct the rule to trigger if an IP address that is not in the 10.x.x.x subnet transmits an IGMP message.
 
    [bookmark: pgfId-3532490]
 
     
     [image: ] 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1919434]Note When building a condition based on events, you can add a correlation rule trigger criterion only if your device can collect the information required for the condition, and your Defense Center can manage that information. For example, because neither Series 2 devices nor the DC500 Defense Center support SSL inspection, URL filtering by category or reputation, or Security Intelligence, you cannot configure event conditions on those appliances based on those features. For more information, see Creating Rules for Correlation Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3451784]To specify correlation rule trigger criteria:
 
    [bookmark: pgfId-3074665]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1903318]Step 1 [bookmark: 19112]Select the type of event on which you want to base your rule.
 
    [bookmark: pgfId-1903319]When you build a correlation rule, you must first select the type of event on which you want to base your rule. You have a few options under Select the type of event for this rule:
 
     
      
      	 [bookmark: pgfId-3201469]Select  an intrusion event occurs to trigger your rule when a specific intrusion event occurs. 
 
      	 [bookmark: pgfId-3201470]Select  a Malware event occurs to trigger the rule when a specific malware event occurs. 
 
      	 [bookmark: pgfId-3285672]Select  a discovery event occurs to trigger the rule when a specific discovery event occurs. When triggering a correlation rule on a discovery event, you must also choose the type of event you want to use. You can choose from a subset of the discovery events described in Understanding Discovery Event Types; you cannot, for example, trigger a correlation rule on a hops change. You can, however, choose  there is any type of event to trigger the rule when any kind of discovery event occurs.
 
      	 [bookmark: pgfId-2395817]Select  user activity is detected  to trigger the rule when a new user is detected or a user logs in to a host.
 
      	 [bookmark: pgfId-2395821]Select  a host input event occurs to trigger the rule when a specific host input event occurs. When triggering a correlation rule on a host input event, you must also choose the type of event you want to use. You can choose from a subset of the events described in Understanding Host Input Event Types.
 
      	 [bookmark: pgfId-3111921]Select  a connection event occurs to trigger the rule when connection data meets specific criteria. When triggering a correlation rule on a connection event, you must also choose whether you want to use connection events that represent the beginning or the ending of the connection, or either. 
 
      	 [bookmark: pgfId-3111922]Select  a traffic profile changes to trigger the correlation rule when network traffic deviates from your normal network traffic pattern as characterized in an existing traffic profile.
 
     
 
    
 
    [bookmark: pgfId-1903342]Step 2 Specify the rule’s conditions.
 
    [bookmark: pgfId-1903343]The syntax you can use within correlation rule trigger criteria conditions varies depending on the base event you chose in step 1, but the mechanics are the same. For more information, see Understanding Rule Building Mechanics.
 
    [bookmark: pgfId-1903353]The syntax you can use to build conditions is described in the following sections:
 
     
      
      	 [bookmark: pgfId-2395832]Syntax for Intrusion Events
 
      	 [bookmark: pgfId-3174502]Syntax for Malware Events
 
      	 [bookmark: pgfId-1903365]Syntax for Discovery Events
 
      	 [bookmark: pgfId-2396682]Syntax for User Activity Events
 
      	 [bookmark: pgfId-2396687]Syntax for Host Input Events
 
      	 [bookmark: pgfId-3052816]Syntax for Connection Events
 
      	 [bookmark: pgfId-2756489]Syntax for Traffic Profile Changes
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-3077006]Tip You can nest rules that share the base event type you specified in step 1. For example, if you create a new rule based on the detection of an open TCP port, the trigger criteria for the new rule could include rule “MyDoom Worm” is true and rule “Kazaa (TCP) P2P” is true.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3077010]Step 3 Optionally, continue with the procedures in the following sections:
 
     
      
      	 [bookmark: pgfId-1903378]Adding a Host Profile Qualification
 
      	 [bookmark: pgfId-1903382]Constraining Correlation Rules Using Connection Data Over Time
 
      	 [bookmark: pgfId-3085714]Adding a User Qualification
 
      	 [bookmark: pgfId-1903386]Adding Snooze and Inactive Periods
 
     
 
    
 
    [bookmark: pgfId-3087384]If you are finished building the correlation rule, continue with step 9 of the procedure in Creating Rules for Correlation Policies to save the rule.
 
    [bookmark: pgfId-3413955]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3051454][bookmark: 11347]Syntax for[bookmark: marker-3051453] Intrusion Events
 
    [bookmark: pgfId-3051458]License: Protection
 
    [bookmark: pgfId-3505002]The following table describes how to build a correlation rule condition when you choose an intrusion event as the base event.
 
     
     [bookmark: pgfId-3505014]If you specify... 
    
 
     
     [bookmark: pgfId-3505016]Select an operator, then... 
    
 
    [bookmark: pgfId-3505018]Access Control Policy
 
    [bookmark: pgfId-3505020]Select one or more access control policies that use the intrusion policy that generated the intrusion event.
 
    [bookmark: pgfId-3505022]Access Control Rule Name
 
    [bookmark: pgfId-3505024]Type all or part of the name of the access control rule that uses the intrusion policy that generated the intrusion event.
 
    [bookmark: pgfId-3505026]Application Protocol
 
    [bookmark: pgfId-3505028]Select one or more application protocols associated with the intrusion event.
 
    [bookmark: pgfId-3505030]Application Protocol Category
 
    [bookmark: pgfId-3505032]Select one or more category of application protocol.
 
    [bookmark: pgfId-3505034]Classification
 
    [bookmark: pgfId-3505036]Select one or more classifications.
 
    [bookmark: pgfId-3505038]Client
 
    [bookmark: pgfId-3505040]Select one or more clients associated with the intrusion event.
 
    [bookmark: pgfId-3505042]Client Category
 
    [bookmark: pgfId-3505044]Select one or more category of client.
 
    [bookmark: pgfId-3505046]Destination Country or Source Country
 
    [bookmark: pgfId-3505048]Select one or more countries associated with the source or destination IP address in the intrusion event.
 
    [bookmark: pgfId-3505050]Destination IP, Source IP, or
Source/Destination IP
 
    [bookmark: pgfId-3505052]Specify a single IP address or an address block. For information on using IP address notation and prefix lengths in the FireSIGHT System, see IP Address Conventions.
 
    [bookmark: pgfId-3505061]Destination Port/ICMP Code or Source Port/ICMP Type
 
    [bookmark: pgfId-3505063]Type the port number or ICMP type for source traffic or the port number or ICMP type for destination traffic.
 
    [bookmark: pgfId-3505065]Device
 
    [bookmark: pgfId-3505067]Select one or more devices that may have generated the event.
 
    [bookmark: pgfId-3505069]Egress Interface or
Ingress Interface
 
    [bookmark: pgfId-3505071]Select one or more interfaces.
 
    [bookmark: pgfId-3505073]Egress Security Zone or Ingress Security Zone
 
    [bookmark: pgfId-3505075]Select one or more security zones.
 
    [bookmark: pgfId-3505077]Generator ID
 
    [bookmark: pgfId-3505081]Select one or more preprocessors. See Configuring Preprocessors in a Network Analysis Policy for more information about available preprocessors.
 
    [bookmark: pgfId-3505084]Impact Flag
 
    [bookmark: pgfId-3505086]Select the impact level assigned to the intrusion event. You select any of the following along with operators that specify is, is not, is greater than, and so on:
 
     
     	 [bookmark: pgfId-3505087]0 — gray (Unknown)
 
     	 [bookmark: pgfId-3505088]1 — red (Vulnerable)
 
     	 [bookmark: pgfId-3505089]2 — orange (Potentially Vulnerable)
 
     	 [bookmark: pgfId-3505090]3 — yellow (Currently Not Vulnerable)
 
     	 [bookmark: pgfId-3505091]4 — blue (Unknown Target)
 
    
 
    [bookmark: pgfId-3505092]Note Because there is no operating system information available for hosts added to the network map based on NetFlow data, the Defense Center cannot assign Vulnerable (level 1: red) impact levels for intrusion events involving those hosts, unless you use the host input feature to manually set the host operating system identity. 
    
 
    [bookmark: pgfId-3505099]For more information, see Using Impact Levels to Evaluate Events.
 
    [bookmark: pgfId-3505101]Inline Result
 
    [bookmark: pgfId-3505103]Select either:
 
     
     	 [bookmark: pgfId-3505104] dropped , to specify whether the packet was dropped in an inline, switched, or routed deployment
 
     	 [bookmark: pgfId-3505105] would have dropped , to specify whether the packet would have dropped if the intrusion policy had been set to drop packets in [bookmark: marker-3505106]an inline, switched, or routed deployment
 
    
 
    [bookmark: pgfId-3505107]Note that the system does not drop packets in a passive deployment, including when an inline set is in tap mode, regardless of the rule state or the drop behavior of the intrusion policy.
 
    [bookmark: pgfId-3505109]Intrusion Policy
 
    [bookmark: pgfId-3505111]Select one or more intrusion policies that generated the intrusion event.
 
    [bookmark: pgfId-3505113]IOC Tag
 
    [bookmark: pgfId-3505115]Select whether an IOC tag is or is not set as a result of the intrusion event.
 
    [bookmark: pgfId-3505117]Priority
 
    [bookmark: pgfId-3505119]Select the rule priority: low, medium, or high.
 
    [bookmark: pgfId-3505120]For rule-based intrusion events, the priority corresponds to either the value of the priority keyword or the value for the classtype keyword. For other intrusion events, the priority is determined by the decoder or preprocessor.
 
    [bookmark: pgfId-3505127]Protocol
 
    [bookmark: pgfId-3505129]Type the name or number of the transport protocol as listed in 
http://www.iana.org/assignments/protocol-numbers.
 
    [bookmark: pgfId-3505132]Rule Message
 
    [bookmark: pgfId-3505134]Type all or part of the rule message.
 
    [bookmark: pgfId-3505136]Rule SID
 
    [bookmark: pgfId-3505138]Type a single Snort ID number (SID) or multiple SIDs separated by commas.
 as the operator, you cannot use the multi-selection pop-up window. You must type a comma-separated list of SIDs. 
    
 
    [bookmark: pgfId-3505141]Rule Type
 
    [bookmark: pgfId-3505143]Specify whether the rule is or is not local. Local rules include custom standard text intrusion rules, standard text rules that you modified, and any new instances of shared object rules created when you saved the rule with modified header information. For more information, see Modifying Existing Rules.
 
    [bookmark: pgfId-3505154]SSL Actual Action
 
    [bookmark: pgfId-3505156]Select the SSL rule action that indicates how the system handled an encrypted connection.
 
    [bookmark: pgfId-3505158]SSL Certificate Fingerprint
 
    [bookmark: pgfId-3505160]Type the fingerprint of the certificate used to encrypt the traffic, or select a subject common name associated with the fingerprint.
 
    [bookmark: pgfId-3505162]SSL Certificate Subject Common Name (CN)
 
    [bookmark: pgfId-3505164]Type all or part of the subject common name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3505166]SSL Certificate Subject Country (C)
 
    [bookmark: pgfId-3505168]Select one or more subject country codes of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3505170]SSL Certificate Subject Organization (O)
 
    [bookmark: pgfId-3505172]Type all or part of the subject organization name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3505174]SSL Certificate Subject Organizational Unit (OU)
 
    [bookmark: pgfId-3505176]Type all or part of the subject organizational unit name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3505178]SSL Flow Status
 
    [bookmark: pgfId-3505180]Select one or more statuses based on the result of the system’s attempt to decrypt the traffic.
 
    [bookmark: pgfId-3505182]Username
 
    [bookmark: pgfId-3505184]Type the username of the user logged into the source host in the intrusion event.
 
    [bookmark: pgfId-3505186]VLAN ID
 
    [bookmark: pgfId-3505188]Type the innermost VLAN ID associated with the packet that triggered the intrusion event
 
    [bookmark: pgfId-3505190]Web Application
 
    [bookmark: pgfId-3505192]Select one or more web applications associated with the intrusion event.
 
    [bookmark: pgfId-3505194]Web Application Category
 
    [bookmark: pgfId-3505196]Select one or more category of web application.
 
   
 
    
     [bookmark: pgfId-3172813][bookmark: 23861]Syntax for[bookmark: marker-3172812] Malware Events
 
    [bookmark: pgfId-3172828]License: Any or Malware
 
    [bookmark: pgfId-3286340]Supported Devices: feature dependent
 
    [bookmark: pgfId-3286341]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-3199297]The syntax for correlation rule conditions based on malware events depends on whether the event is reported by an endpoint-based malware agent, detected by a managed device, or detected by a managed device and retrospectively identified as malware.
 
    [bookmark: pgfId-3286398]Note that because Series 2 and Cisco NGIPS for Blue Coat X-Series devices and the DC500 Defense Center do not support network-based malware protection, these appliances do not support triggering a correlation rule on a malware event based on network-based malware data or retrospective network-based malware data.
 
    [bookmark: pgfId-3505249]When you build rule conditions, you should make sure that your network traffic can trigger the rules. The information available for any individual connection or connection summary event depends on several factors, including the detection method, the logging method, and event type. For more information, see Understanding the Malware Events Table.
 
     
     [bookmark: pgfId-3377950]If you specify... 
    
 
     
     [bookmark: pgfId-3377952]Select an operator, then... 
    
 
    [bookmark: pgfId-3377954]Application Protocol
 
    [bookmark: pgfId-3377956]Select one or more application protocols associated with the malware event.
 
    [bookmark: pgfId-3377958]Application Protocol Category
 
    [bookmark: pgfId-3377960]Select one or more category of application protocol.
 
    [bookmark: pgfId-3377962]Client
 
    [bookmark: pgfId-3377964]Select one or more clients associated with the malware event.
 
    [bookmark: pgfId-3377966]Client Category
 
    [bookmark: pgfId-3377968]Select one or more category of client.
 
    [bookmark: pgfId-3377970]Destination Country or Source Country
 
    [bookmark: pgfId-3377972]Select one or more countries associated with the source or destination IP address in the malware event.
 
    [bookmark: pgfId-3377974]Destination IP, Host IP, or Source IP 
 
    [bookmark: pgfId-3377976]Specify a single IP address or address block. For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
 
    [bookmark: pgfId-3377984]Destination Port/ICMP Code
 
    [bookmark: pgfId-3377986]Type the port number or ICMP code for destination traffic.
 
    [bookmark: pgfId-3377988]Disposition
 
    [bookmark: pgfId-3377990]Select either or both Malware or Custom Detection.
 
    [bookmark: pgfId-3377992]Event Type
 
    [bookmark: pgfId-3377994]Select one or more endpoint-based event types associated with the malware event. For more information, see Malware Event Types.
 
    [bookmark: pgfId-3377999]File Name
 
    [bookmark: pgfId-3378001]Type the name of the file.
 
    [bookmark: pgfId-3378003]File Type
 
    [bookmark: pgfId-3378005]Select the type of file, for example, PDF or MSEXE.
 
    [bookmark: pgfId-3378007]File Type Category
 
    [bookmark: pgfId-3378009]Select one or more file type categories, for example, Office Documents or Executables.
 
    [bookmark: pgfId-3378011]IOC Tag
 
    [bookmark: pgfId-3378013]Select whether an IOC tag is or is not set as a result of the malware event.
 
    [bookmark: pgfId-3378015]SHA-256
 
    [bookmark: pgfId-3378017]Type or paste the SHA-256 hash value of the file.
 
    [bookmark: pgfId-3378527]SSL Actual Action
 
    [bookmark: pgfId-3378529]Select the SSL rule action that indicates how the system handled an encrypted connection.
 
    [bookmark: pgfId-3378523]SSL Certificate Fingerprint
 
    [bookmark: pgfId-3378525]Type the fingerprint of the certificate used to encrypt the traffic, or select a subject common name associated with the fingerprint.
 
    [bookmark: pgfId-3378519]SSL Certificate Subject Common Name (CN)
 
    [bookmark: pgfId-3378521]Type all or part of the subject common name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3378515]SSL Certificate Subject Country (C)
 
    [bookmark: pgfId-3378517]Select one or more subject country codes of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3378511]SSL Certificate Subject Organization (O)
 
    [bookmark: pgfId-3378513]Type all or part of the subject organization name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3378507]SSL Certificate Subject Organizational Unit (OU)
 
    [bookmark: pgfId-3378509]Type all or part of the subject organizational unit name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3378503]SSL Flow Status
 
    [bookmark: pgfId-3378505]Select one or more statuses based on the result of the system’s attempt to decrypt the traffic.
 
    [bookmark: pgfId-3378019]Source Port/ICMP Type
 
    [bookmark: pgfId-3378021]Type the port number or ICMP type for source traffic.
 
    [bookmark: pgfId-3378023]Web Application
 
    [bookmark: pgfId-3378025]Select one or more web applications associated with the malware event.
 
    [bookmark: pgfId-3378027]Web Application Category
 
    [bookmark: pgfId-3378029]Select one or more category of web application.
 
   
 
    
     [bookmark: pgfId-3172024][bookmark: 64518]Syntax for[bookmark: marker-3172023] Discovery Events
 
    [bookmark: pgfId-3172028]License: FireSIGHT
 
    [bookmark: pgfId-2452850]If you base your correlation rule on a discovery event, you must first choose the type of event you want to use from a drop-down list. The following table lists the events you can choose as trigger criteria from the drop-down list, cross-referenced with their corresponding event types. For detailed descriptions of discovery event types, see Understanding Discovery Event Types.
 
     
      [bookmark: pgfId-2789386]
 
      
       
        
        [bookmark: pgfId-3107252]Table 51-4 Correlation Rule Trigger Criteria vs. Discovery Event Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-3107256]Select this option... 
          
  
         	 
           
           [bookmark: pgfId-3107258]To trigger the rule on this event type... 
          
  
        
 
         
         	[bookmark: pgfId-3122477]a [bookmark: marker-3222266]client has changed
  
         	[bookmark: pgfId-3122480][bookmark: marker-3122479]Client Update
  
        
 
         
         	[bookmark: pgfId-3122472]a client timed out
  
         	[bookmark: pgfId-3122475][bookmark: marker-3122474]Client Timeout
  
        
 
         
         	[bookmark: pgfId-3122467]a host IP address is reused
  
         	[bookmark: pgfId-3122470][bookmark: marker-3122469]DHCP: IP Address Reassigned
  
        
 
         
         	[bookmark: pgfId-3122462]a host is deleted because the host limit was reached
  
         	[bookmark: pgfId-3122465][bookmark: marker-3122464]Host Deleted: Host Limit Reached
  
        
 
         
         	[bookmark: pgfId-3122457]a host is identified as a network device
  
         	[bookmark: pgfId-3122460][bookmark: marker-3122459]Host Type Changed to Network Device
  
        
 
         
         	[bookmark: pgfId-3122452]a host timed out
  
         	[bookmark: pgfId-3122455][bookmark: marker-3122454]Host Timeout
  
        
 
         
         	[bookmark: pgfId-3122447]a host’s IP address has changed
  
         	[bookmark: pgfId-3122450][bookmark: marker-3122449]DHCP: IP Address Changed
  
        
 
         
         	[bookmark: pgfId-3122442]a NETBIOS name change is detected
  
         	[bookmark: pgfId-3122445][bookmark: marker-3122444]NETBIOS Name Change
  
        
 
         
         	[bookmark: pgfId-3122437]a new client is detected
  
         	[bookmark: pgfId-3122440][bookmark: marker-3122439]New Client
  
        
 
         
         	[bookmark: pgfId-3122432]a new IP host is detected
  
         	[bookmark: pgfId-3122435][bookmark: marker-3122434]New Host
  
        
 
         
         	[bookmark: pgfId-3122427]a new MAC address is detected
  
         	[bookmark: pgfId-3122430][bookmark: marker-3122429]Additional MAC Detected for Host
  
        
 
         
         	[bookmark: pgfId-3122422]a new MAC host is detected
  
         	[bookmark: pgfId-3122425][bookmark: marker-3122424]New Host
  
        
 
         
         	[bookmark: pgfId-3122417]a new network protocol is detected
  
         	[bookmark: pgfId-3122420][bookmark: marker-3122419]New Network Protocol
  
        
 
         
         	[bookmark: pgfId-3122482]a new transport protocol is detected
  
         	[bookmark: pgfId-3122485][bookmark: marker-3122484]New Transport Protocol
  
        
 
         
         	[bookmark: pgfId-3122492]a TCP port closed
  
         	[bookmark: pgfId-3122495][bookmark: marker-3122494]TCP Port Closed
  
        
 
         
         	[bookmark: pgfId-3122487]a TCP port timed out
  
         	[bookmark: pgfId-3122490][bookmark: marker-3122489]TCP Port Timeout
  
        
 
         
         	[bookmark: pgfId-3122507]a UDP port closed
  
         	[bookmark: pgfId-3122510][bookmark: marker-3122509]UDP Port Closed
  
        
 
         
         	[bookmark: pgfId-3122502]a UDP port timed out
  
         	[bookmark: pgfId-3122505][bookmark: marker-3122504]UDP Port Timeout
  
        
 
         
         	[bookmark: pgfId-3122497]a VLAN tag was updated
  
         	[bookmark: pgfId-3122500][bookmark: marker-3122499]VLAN Tag Information Update
  
        
 
         
         	[bookmark: pgfId-3372707]an IOC was set
  
         	[bookmark: pgfId-3372709]Indication of Compromise
  
        
 
         
         	[bookmark: pgfId-3122512]an open TCP port is detected
  
         	[bookmark: pgfId-3122515][bookmark: marker-3122514]New TCP Port
  
        
 
         
         	[bookmark: pgfId-3122532]an open UDP port is detected
  
         	[bookmark: pgfId-3122535][bookmark: marker-3122534]New UDP Port
  
        
 
         
         	[bookmark: pgfId-3122527]the OS information for a host has changed
  
         	[bookmark: pgfId-3122530][bookmark: marker-3122529]New OS
  
        
 
         
         	[bookmark: pgfId-3122522]the OS or server identity for a host has a conflict
  
         	[bookmark: pgfId-3122525][bookmark: marker-3122524]Identity Conflict
  
        
 
         
         	[bookmark: pgfId-3122517]the OS or server identity for a host has timed out
  
         	[bookmark: pgfId-3122520][bookmark: marker-3122519]Identity Timeout
  
        
 
         
         	[bookmark: pgfId-3122552]there is any kind of event
  
         	[bookmark: pgfId-3122554]any event type
  
        
 
         
         	[bookmark: pgfId-3122547]there is new information about a MAC address
  
         	[bookmark: pgfId-3122550][bookmark: marker-3122549]MAC Information Change
  
        
 
         
         	[bookmark: pgfId-3122542]there is new information about a TCP server
  
         	[bookmark: pgfId-3122545][bookmark: marker-3122544]TCP Server Information Update
  
        
 
         
         	[bookmark: pgfId-3122537]there is new information about a UDP server
  
         	[bookmark: pgfId-3122540][bookmark: marker-3122539]UDP Server Information Update
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2802520]Note that you cannot trigger a correlation rule on hops changes, or when the system drops a new host due to reaching the licensed host limit. You can, however, choose there is any type of event to trigger the rule when any type of discovery event occurs.
 
      
      [bookmark: pgfId-3188412]If you specify... 
     
 
      
      [bookmark: pgfId-3188414]Select an operator, then... 
     
 
     [bookmark: pgfId-3188416]Application Pro[bookmark: marker-3222292]tocol
 
     [bookmark: pgfId-3188418]Select one or more application protocols.
 
     [bookmark: pgfId-3302205]Application Protocol Category
 
     [bookmark: pgfId-3302207]Select one or more category of application protocol.
 
     [bookmark: pgfId-3188420]Application Port
 
     [bookmark: pgfId-3188422]Type the application protocol port number.
 
     [bookmark: pgfId-3188424]Cl[bookmark: marker-3222287]ient
 
     [bookmark: pgfId-3188426]Select one or more clients.
 
     [bookmark: pgfId-3302231]Client Category
 
     [bookmark: pgfId-3302233]Select one or more category of client.
 
     [bookmark: pgfId-3188428]Client Version
 
     [bookmark: pgfId-3188430]Type the version number of the client.
 
     [bookmark: pgfId-3188432]Device
 
     [bookmark: pgfId-3188434]Select one or more devices that may have generated the discovery event.
 
     [bookmark: pgfId-3209971]Hardware
 
     [bookmark: pgfId-3209973]Type the hardware model for the mobile device. For example, to match all Apple iPhones, type iPhone.
 
     [bookmark: pgfId-3188436]Host Type
 
     [bookmark: pgfId-3188438]Select one or more host types from the drop-down list. You can choose between a host or one of several types of network device.
 
     [bookmark: pgfId-3188440]IP Address or
New IP Address
 
     [bookmark: pgfId-3188442]Type a single IP address or address block. For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-3209979]Jailbroken
 
     [bookmark: pgfId-3209981]Select Yes to indicate that the host in the event is a jailbroken mobile device or No to indicate that it is not.
 
     [bookmark: pgfId-3188450]MAC Address
 
     [bookmark: pgfId-3188452]Type all or part of the MAC address of the host. 
 
     [bookmark: pgfId-3188453]For example, if you know that devices from a certain hardware manufacturer have MAC addresses that begin with 0A:12:34, you could choose begins with as the operator, then type 0A:12:34 as the value.
 
     [bookmark: pgfId-3188455]MAC Type
 
     [bookmark: pgfId-3188457]Select whether the MAC address was ARP/DHCP Detected.
 
     [bookmark: pgfId-3188458]That is, select whether the system positively identified the MAC address as belonging to the host (is ARP/DHCP Detected), or whether the system is seeing many hosts with that MAC address because, for example, there is a router between the managed device and the host (is not ARP/DHCP Detected).
 
     [bookmark: pgfId-3188460]MAC Vendor
 
     [bookmark: pgfId-3188462]Type all or part of the name of the MAC hardware vendor of the NIC used by the network traffic that triggered the discovery event.
 
     [bookmark: pgfId-3210391]Mobile
 
     [bookmark: pgfId-3210393]Select Yes to indicate that the host in the event is a mobile device or No to indicate that it is not.
 
     [bookmark: pgfId-3464663]NETBIOS Name
 
     [bookmark: pgfId-3464665]Type the NetBIOS name of the host.
 
     [bookmark: pgfId-3188470]Network Protocol
 
     [bookmark: pgfId-3188473]Type the network protocol number as listed in http://www.iana.org/assignments/ethernet-numbers.
 
     [bookmark: pgfId-3188475]OS Name
 
     [bookmark: pgfId-3188477]Select one or more operating system names.
 
     [bookmark: pgfId-3188479]OS Vendor
 
     [bookmark: pgfId-3188481]Select one or more operating system vendors.
 
     [bookmark: pgfId-3188483]OS Version
 
     [bookmark: pgfId-3188485]Select one or more operating system versions.
 
     [bookmark: pgfId-3188487]Protocol or
Transport Protocol
 
     [bookmark: pgfId-3188489]Type the name or number of the transport protocol as listed in
http://www.iana.org/assignments/protocol-numbers.
 
     [bookmark: pgfId-3188492]Source
 
     [bookmark: pgfId-3188494]Select the source of the host input data (for operating system and server identity changes and timeouts).
 
     [bookmark: pgfId-3188496]Source Type
 
     [bookmark: pgfId-3188498]Select the type of the source for the host input data (for operating system and server identity changes and timeouts).
 
     [bookmark: pgfId-3188500]VLAN ID
 
     [bookmark: pgfId-3188502]Type the VLAN ID of the host involved in the event.
 
     [bookmark: pgfId-3188576]Web A[bookmark: marker-3222297]pplication
 
     [bookmark: pgfId-3188578]Select a web application.
 
    
 
   
 
    
     [bookmark: pgfId-2873671][bookmark: 53825]Syntax for User Activity Eve[bookmark: marker-2873803]nts
 
    [bookmark: pgfId-2976881]License: FireSIGHT
 
    [bookmark: pgfId-2873686]If you base your correlation rule on user activity, you must first choose the type of user activity you want to use from a drop-down list, either:
 
     
     	 [bookmark: pgfId-3057081]a user logged into a host, or
 
     	 [bookmark: pgfId-3057122]a new user identity was detected
 
    
 
     
     [bookmark: pgfId-3057186]If you specify... 
    
 
     
     [bookmark: pgfId-3057188]Select an operator, then... 
    
 
    [bookmark: pgfId-3281863]Device
 
    [bookmark: pgfId-3281865]Select one or more devices that may have detected the user activity.
 
    [bookmark: pgfId-3057198]IP Address
 
    [bookmark: pgfId-3062154]Type a single IP address or address block. For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
 
    [bookmark: pgfId-3057202]Username
 
    [bookmark: pgfId-3057204]Type a username.
 
   
 
    
     [bookmark: pgfId-2396698][bookmark: 60865]Syntax for [bookmark: marker-2872069]Host Input Events
 
    [bookmark: pgfId-2976936]License: FireSIGHT
 
    [bookmark: pgfId-2795036]If you base your correlation rule on a host input event, you must first choose the type of host input event you want to use from a drop-down list. The following table lists the events you can choose as trigger criteria from the drop-down list, cross-referenced with their corresponding host input event types. For detailed descriptions of host input event types, see Understanding Host Input Event Types.
 
     
      [bookmark: pgfId-2795189]
 
      
       
        
        [bookmark: pgfId-2795057]Table 51-7 Correlation Rule Trigger Criteria vs. Host Input Event Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-3111934]Select this option... 
          
  
         	 
           
           [bookmark: pgfId-3111936]To trigger the rule on this event type... 
          
  
        
 
         
         	[bookmark: pgfId-3122328]a client is added
  
         	[bookmark: pgfId-3122331][bookmark: marker-3122330]Add Client
  
        
 
         
         	[bookmark: pgfId-3122323]a client is deleted
  
         	[bookmark: pgfId-3122326][bookmark: marker-3122325]Delete Client
  
        
 
         
         	[bookmark: pgfId-3122348]a host is added
  
         	[bookmark: pgfId-3122351][bookmark: marker-3122350]Add Host
  
        
 
         
         	[bookmark: pgfId-3122343]a protocol is added
  
         	[bookmark: pgfId-3122346][bookmark: marker-3122345]Add Protocol
  
        
 
         
         	[bookmark: pgfId-3122338]a protocol is deleted
  
         	[bookmark: pgfId-3122341][bookmark: marker-3122340]Delete Protocol
  
        
 
         
         	[bookmark: pgfId-3122333]a scan result is added
  
         	[bookmark: pgfId-3122336][bookmark: marker-3122335]Add Scan Result
  
        
 
         
         	[bookmark: pgfId-3122363]a server definition is set
  
         	[bookmark: pgfId-3122366][bookmark: marker-3122365]Set Server Definition
  
        
 
         
         	[bookmark: pgfId-3122358]a server is added
  
         	[bookmark: pgfId-3122361][bookmark: marker-3122360]Add Port
  
        
 
         
         	[bookmark: pgfId-3122353]a server is deleted
  
         	[bookmark: pgfId-3122356][bookmark: marker-3122355]Delete Port
  
        
 
         
         	[bookmark: pgfId-3122373]a vulnerability is marked invalid
  
         	[bookmark: pgfId-3122376][bookmark: marker-3122375]Vulnerability Set Invalid
  
        
 
         
         	[bookmark: pgfId-3122368]a vulnerability is marked valid
  
         	[bookmark: pgfId-3122371][bookmark: marker-3122370]Vulnerability Set Valid
  
        
 
         
         	[bookmark: pgfId-3122378]an address is deleted
  
         	[bookmark: pgfId-3122381][bookmark: marker-3122380]Delete Host/Network
  
        
 
         
         	[bookmark: pgfId-3122393]an attribute value is deleted
  
         	[bookmark: pgfId-3122396][bookmark: marker-3122395]Host Attribute Delete Value
  
        
 
         
         	[bookmark: pgfId-3122388]an attribute value is set
  
         	[bookmark: pgfId-3122391][bookmark: marker-3122390]Host Attribute Set Value
  
        
 
         
         	[bookmark: pgfId-3122383]an OS definition is set
  
         	[bookmark: pgfId-3122386][bookmark: marker-3122385]Set Operating System Definition
  
        
 
         
         	[bookmark: pgfId-3122398]host criticality is set
  
         	[bookmark: pgfId-3122401][bookmark: marker-3122400]Set Host Criticality
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2802594]You cannot trigger a correlation rule when you add, delete, or change the definition of a user-defined host attribute, or set a vulnerability impact qualification.
 
      
      [bookmark: pgfId-3061038]If you specify... 
     
 
      
      [bookmark: pgfId-3061040]Select an operator, then... 
     
 
     [bookmark: pgfId-3061042]IP Address
 
     [bookmark: pgfId-3061044]Type a single IP address or address block. For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-3281879]Source
 
     [bookmark: pgfId-3281881]Select the source for the host input data.
 
     [bookmark: pgfId-3061052]Source Type
 
     [bookmark: pgfId-3061054]Select the type of the source for the host input data.
 
    
 
   
 
    
     [bookmark: pgfId-3052423][bookmark: 97727]Syntax for Connection[bookmark: marker-3052422] Events
 
    [bookmark: pgfId-3067388]License: Any
 
    [bookmark: pgfId-3052428]If you base your correlation rule on a connection event, you must first choose whether you want to evaluate events that represent the beginning or ending of the connection, or either the beginning or the end. After you choose the connection event type, you can build correlation rule conditions as described in the Syntax for Connection Events table.
 
     
     [bookmark: pgfId-3131390]If you specify... 
    
 
     
     [bookmark: pgfId-3131392]Select an operator, then... 
    
 
    [bookmark: pgfId-3281929]Access Control Policy
 
    [bookmark: pgfId-3281931]Select one or more access control policies that logged the connection.
 
    [bookmark: pgfId-3281951]Access Control Rule Action
 
    [bookmark: pgfId-3281953]Select one or more actions associated with the access control rule that logged the connection.
 to trigger correlation events when network traffic matches the conditions of any Monitor rule, regardless of the rule or default action that later handles the connection. 
    
 
    [bookmark: pgfId-3281933]Access Control Rule Name
 
    [bookmark: pgfId-3281935]Type all or part of the name of the access control rule that logged the connection.
 
    [bookmark: pgfId-3281936]Note You can type the name of any Monitor rule whose conditions were matched by a connection, regardless of the rule or default action that later handled the connection. 
    
 
    [bookmark: pgfId-3281964]Application Protocol
 
    [bookmark: pgfId-3281966]Select one or more application protocols associated with the connection.
 
    [bookmark: pgfId-3302259]Application Protocol Category
 
    [bookmark: pgfId-3302261]Select one or more category of application protocol.
 
    [bookmark: pgfId-3281977]Clie[bookmark: marker-3281976]nt
 
    [bookmark: pgfId-3281979]Select one or more clients.
 
    [bookmark: pgfId-3302275]Client Category
 
    [bookmark: pgfId-3302277]Select one or more category of client.
 
    [bookmark: pgfId-3281981]Client Version
 
    [bookmark: pgfId-3281983]Type the version number of the client.
 
    [bookmark: pgfId-3281993]Connection Duration
 
    [bookmark: pgfId-3281995]Type the duration of the connection event, in seconds.
 
    [bookmark: pgfId-3281997]Connection Type
 
    [bookmark: pgfId-3281999]Select whether you want to trigger the correlation rule based on whether the connection was detected by a Cisco managed device (FireSIGHT) or was exported by a NetFlow-enabled device (NetFlow).
 
    [bookmark: pgfId-3363324]Destination Country or Source Country
 
    [bookmark: pgfId-3363326]Select one or more countries associated with the source or destination IP address in the connection event.
 
    [bookmark: pgfId-3282007]Device
 
    [bookmark: pgfId-3282009]Select one or more devices that either detected the connection, or that processed the connection (for connection data exported by a NetFlow-enabled device).
 
    [bookmark: pgfId-3282011]Egress Interface or
Ingress Interface
 
    [bookmark: pgfId-3282013]Select one or more interfaces.
 
    [bookmark: pgfId-3131394]Egress Security Zone or
Ingress Security Zone
 
    [bookmark: pgfId-3131396]Select one or more security zones.
 
    [bookmark: pgfId-3282027]Initiator Bytes, 
Responder Bytes, or
Total Bytes
 
    [bookmark: pgfId-3282029]Type one of:
 
     
     	 [bookmark: pgfId-3282030]the number of bytes transmitted ( Initiator Bytes ).
 
     	 [bookmark: pgfId-3282031]the number of bytes received ( Responder Bytes ).
 
     	 [bookmark: pgfId-3282032]the number of bytes both transmitted and received ( Total Bytes ).
 
    
 
    [bookmark: pgfId-3282057]Initiator IP,
Responder IP, or
Initiator/Responder IP
 
    [bookmark: pgfId-3282059]Specify a single IP address or an address block. For information on using IP address notation and prefix lengths in the FireSIGHT System, see IP Address Conventions.
 
    [bookmark: pgfId-3282034]Initiator Packets, 
Responder Packets, or
Total Packets
 
    [bookmark: pgfId-3282036]Type one of:
 
     
     	 [bookmark: pgfId-3282037]the number of packets transmitted ( Initiator Packets ).
 
     	 [bookmark: pgfId-3282038]the number of packets received ( Responder Packets ).
 
     	 [bookmark: pgfId-3282039]the number of packets both transmitted and received ( Total Packets )
 
    
 
    [bookmark: pgfId-3131416]Initiator Port/ICMP Type or Responder Port/ICMP Code
 
    [bookmark: pgfId-3131418]Type the port number or ICMP type for initiator traffic or the port number or ICMP code for responder traffic.
 
    [bookmark: pgfId-3302574]IOC Tag
 
    [bookmark: pgfId-3302596]Select whether an IOC tag is or is not set as a result of the connection event.
 
    [bookmark: pgfId-3464697]NETBIOS Name
 
    [bookmark: pgfId-3464699]Type the NetBIOS name of the monitored host in the connection.
 
    [bookmark: pgfId-3131440]NetFlow Device
 
    [bookmark: pgfId-3131442]Select the IP address of the NetFlow-enabled device that exported the connection data you want to use to trigger the correlation rule. If you did not add any NetFlow-enabled devices to your deployment, the NetFlow Device drop-down list is blank.
 
    [bookmark: pgfId-3282095]Reason
 
    [bookmark: pgfId-3282097]Select one or more reasons associated with the connection event.
 
    [bookmark: pgfId-3363747]Security Intelligence Category
 
    [bookmark: pgfId-3363749]Select one or more Security Intelligence categories associated with the connection event.
 in the Security Intelligence section of your access control policy. For more information, see 
    Building the Security Intelligence Whitelist and Blacklist. 
    
 
    [bookmark: pgfId-3373523]SSL Actual Action
 
    [bookmark: pgfId-3373525]Select the SSL rule action that indicates how the system handled an encrypted connection. 
 
    [bookmark: pgfId-3373527]SSL Certificate Fingerprint
 
    [bookmark: pgfId-3374690]Type the fingerprint of the certificate used to encrypt the traffic, or select a subject common name associated with the fingerprint.
 
    [bookmark: pgfId-3373531]SSL Certificate Status
 
    [bookmark: pgfId-3373533]Select one or more statuses associated with the certificate used to encrypt the session.
 
    [bookmark: pgfId-3373535]SSL Certificate Subject Common Name (CN)
 
    [bookmark: pgfId-3373537]Type all or part of the subject common name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3373539]SSL Certificate Subject Country (C)
 
    [bookmark: pgfId-3373541]Select one or more subject country codes of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3373543]SSL Certificate Subject Organization (O)
 
    [bookmark: pgfId-3373545]Type all or part of the subject organization name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3373547]SSL Certificate Subject Organizational Unit (OU)
 
    [bookmark: pgfId-3373549]Type all or part of the subject organizational unit name of the certificate used to encrypt the session.
 
    [bookmark: pgfId-3373551]SSL Cipher Suite
 
    [bookmark: pgfId-3373553]Select one or more cipher suites used to encrypt the session.
 
    [bookmark: pgfId-3373555]SSL Encrypted Session
 
    [bookmark: pgfId-3373557]Select Successfully Decrypted.
 
    [bookmark: pgfId-3373559]SSL Flow Status
 
    [bookmark: pgfId-3373561]Select one or more statuses based on the result of the system’s attempt to decrypt the traffic.
 
    [bookmark: pgfId-3373563]SSL Policy
 
    [bookmark: pgfId-3375664]Select one or more SSL policies that logged the encrypted connection.
 
    [bookmark: pgfId-3373567]SSL Rule Name
 
    [bookmark: pgfId-3375690]Type all or part of the name of the SSL rule that logged the encrypted connection.
 
    [bookmark: pgfId-3373571]SSL Server Name
 
    [bookmark: pgfId-3373573]Type all or part of the name of the server with which the client established an encrypted connection.
 
    [bookmark: pgfId-3373575]SSL URL Category
 
    [bookmark: pgfId-3373577]Select one or more URL categories for the URL visited in the encrypted connection.
 
    [bookmark: pgfId-3373579]SSL Version
 
    [bookmark: pgfId-3373581]Select one or more SSL or TLS versions used to encrypt the session.
 
    [bookmark: pgfId-3131444]TCP Flags
 
    [bookmark: pgfId-3131446]Select a TCP flag that a connection event must contain in order to trigger the correlation rule.
 
    [bookmark: pgfId-3131447]Note Only connection data exported by NetFlow-enabled devices contain TCP flags. 
    
 
    [bookmark: pgfId-3282075]Transport Protocol
 
    [bookmark: pgfId-3282077]Type the transport protocol used by the connection: TCP or UDP.
 
    [bookmark: pgfId-3282115]URL
 
    [bookmark: pgfId-3282117]Type all or part of the URL visited in the connection.
 
    [bookmark: pgfId-3282135]URL Category
 
    [bookmark: pgfId-3282137]Select one or more URL categories for the URL visited in the connection.
 
    [bookmark: pgfId-3282139]URL Reputation
 
    [bookmark: pgfId-3282141]Select one or more URL reputation values for the URL visited in the connection.
 
    [bookmark: pgfId-3131475]Username
 
    [bookmark: pgfId-3131477]Type the username of the user logged into either host in the connection.
 
    [bookmark: pgfId-3159763]Web A[bookmark: marker-3222302]pplication
 
    [bookmark: pgfId-3159781]Select one or more web applications associated with the connection.
 
    [bookmark: pgfId-3302315]Web Application Category
 
    [bookmark: pgfId-3302317]Select one or more category of web application.
 
   
 
    
     [bookmark: pgfId-2396693][bookmark: 87024]Syntax for[bookmark: marker-2276581] Traffic Profile Changes
 
    [bookmark: pgfId-3067401]License: Any
 
    [bookmark: pgfId-1903681]If you base your correlation rule on a traffic profile change, the rule triggers when network traffic deviates from your normal network traffic pattern as characterized in an existing traffic profile. For information on how to build a traffic profile, see Creating Traffic Profiles.
 
    [bookmark: pgfId-1903685]You can trigger the rule based on either raw data or on the statistics calculated from the data. For example, you could write a rule that triggers if the amount of data traversing your network (measured in bytes) suddenly spikes, which could indicate an attack or other security policy violation. You could specify that the rule trigger if either:
 
     
     	 [bookmark: pgfId-1903686]the number of bytes traversing your network spikes above a certain number of standard deviations above or below the mean amount of traffic
 
    
 
    [bookmark: pgfId-2002572]Note that to create a rule that triggers when the number of bytes traversing your network falls outside a certain number of standard deviations (whether above or below), you must specify upper and lower bounds, as shown in the following graphic.
 
    [bookmark: pgfId-2002576]
 
     
      [bookmark: pgfId-3532530]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-2002640]To create a rule that triggers when the number of bytes traversing is greater than a certain number of standard deviations above the mean, use only the first condition shown in the graphic. 
 
     [bookmark: pgfId-2008891]To create a rule that triggers when the number of bytes traversing is greater than a certain number of standard deviations below the mean, use only the second condition.
 
      
      	 [bookmark: pgfId-2002541]the number of bytes traversing your network spikes above a certain number of bytes 
 
     
 
     [bookmark: pgfId-1903688]You can select the use velocity data check box (see Changing the Graph Type), to trigger the correlation rule based on rates of change between data points. If you wanted to use velocity data in the above example, you could specify that the rule triggers if either:
 
      
      	 [bookmark: pgfId-1903689]the change in the number of bytes traversing your network spikes above or below a certain number of standard deviations above the mean rate of change
 
      	 [bookmark: pgfId-1903690]the change in the number of bytes traversing your network spikes above a certain number of bytes
 
     
 
     [bookmark: pgfId-1903700]The following table describes how to build a condition in a correlation rule when you choose a traffic profile change as the base event. If your traffic profile uses connection data exported by NetFlow-enabled devices, see Differences Between NetFlow and FireSIGHT Data to learn about how the detection method can affect the data used to create your traffic profile.
 
    
 
     
      [bookmark: pgfId-1903769]
 
      
       
        
        [bookmark: pgfId-1903707]Table 51-10 [bookmark: 20735]Syntax for Traffic Profile Changes 
 
        
        
         
         	 
           
           [bookmark: pgfId-1903713]If you specify... 
          
  
         	 
           
           [bookmark: pgfId-1903715]Select an operator, then type... 
          
  
         	 
           
           [bookmark: pgfId-1903717]And then choose one of the following... 
          
  
        
 
         
         	[bookmark: pgfId-1903719]Number of Connections
  
         	[bookmark: pgfId-1903721]the total number of connections detected
 [bookmark: pgfId-1903722]or
 [bookmark: pgfId-1903723]the number of standard deviations either above or below the mean that the number of connections detected must be in to trigger the rule
  
         	[bookmark: pgfId-1903725]connections
 [bookmark: pgfId-1903726]standard deviation(s)
  
        
 
         
         	[bookmark: pgfId-1903728]Total Bytes,
Initiator Bytes, or
Responder Bytes
  
         	[bookmark: pgfId-3057473]one of:
 
           
           	 [bookmark: pgfId-3057474]the total bytes transmitted ( Total Bytes )
 
           	 [bookmark: pgfId-3057475]the number of bytes transmitted ( Initiator Bytes )
 
           	 [bookmark: pgfId-3057470]the number of bytes received ( Responder Bytes )
 
          
 [bookmark: pgfId-1903734]or
 [bookmark: pgfId-1903735]the number of standard deviations either above or below the mean that one of the above criteria must be in to trigger the rule
  
         	[bookmark: pgfId-1903737]bytes
 [bookmark: pgfId-1903738]standard deviation(s)
  
        
 
         
         	[bookmark: pgfId-1903740]Total Packets,
Initiator Packets, or
Responder Packets
  
         	[bookmark: pgfId-1903742]one of:
 
           
           	 [bookmark: pgfId-1903743]the total packets transmitted ( Total Packets )
 
           	 [bookmark: pgfId-1903744]the number of packets transmitted ( Initiator Packets )
 
           	 [bookmark: pgfId-1903745]the number of packets received ( Responder Packets )
 
          
 [bookmark: pgfId-1903746]or
 [bookmark: pgfId-1903747]the number of standard deviations either above or below the mean that one of the above criteria must be in trigger the rule
  
         	[bookmark: pgfId-1903749]packets
 [bookmark: pgfId-1903750]standard deviation(s)
  
        
 
         
         	[bookmark: pgfId-1903752]Unique Initiators
  
         	[bookmark: pgfId-1945141]the number of unique hosts that initiated sessions
 [bookmark: pgfId-1903755]or
 [bookmark: pgfId-1903756]the number of standard deviations either above or below the mean that the number of unique initiators detected must be to trigger the rule
  
         	[bookmark: pgfId-1903758]initiators
 [bookmark: pgfId-1903759]standard deviation(s)
  
        
 
         
         	[bookmark: pgfId-1903761]Unique Responders
  
         	[bookmark: pgfId-1903763]the number of unique hosts that responded to sessions
 [bookmark: pgfId-1903764]or
 [bookmark: pgfId-1903765]the number of standard deviations either above or below the mean that the number of unique responders detected must be to trigger the rule
  
         	[bookmark: pgfId-1903767]responders
 [bookmark: pgfId-1903768]standard deviation(s)
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1952087][bookmark: 91923]Adding a[bookmark: marker-2276583] Host Profile Qualification
 
    [bookmark: pgfId-2976992]License: FireSIGHT
 
    [bookmark: pgfId-1903775]If you are using a connection, intrusion, discovery, user activity, or host input event to trigger your correlation rule, you can constrain the rule based on the host profile of a host involved in the event. This constraint is called a host profile qualification.
 
     
      
    
 
    
 
    [bookmark: pgfId-2216828]Note You cannot add a host profile qualification to a correlation rule that triggers on a malware event, traffic profile change, or on the detection of a new IP host.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1922700]For example, you could constrain a correlation rule so that it triggers only when a Microsoft Windows host is the target of the offending traffic, because only Microsoft Windows computers are vulnerable to the vulnerability the rule is written for. As another example, you could constrain a correlation rule so that it triggers only when the host is out of compliance with a white list.
 
    [bookmark: pgfId-3363630]To match against implied or generic [bookmark: marker-3363629]clients, create a host profile qualification based on the application protocol used by the server responding to the client. When the client list on a host that acts as the initiator or source of a connection includes an application protocol name followed by client, that client may actually be an implied client. In other words, the system reports that client based on server response traffic that uses the application protocol for that client, not on detected client traffic. 
 
    [bookmark: pgfId-3214894]For example, if the system reports HTTPS client as a client on a host, create a host profile qualification for Responder Host or Destination Host where Application Protocol is set to HTTPS, because HTTPS client is reported as a generic client based on the HTTPS server response traffic sent by the responder or destination host.
 
    [bookmark: pgfId-2297747]Note that to use a host profile qualification, the host must exist in the network map and the host profile property you want to use as a qualification must already be included in the host profile. For example, if you configure a correlation rule to trigger when an intrusion event is generated for a host running Windows, the rule only triggers if the host is already identified as Windows when the intrusion event is generated.
 
    [bookmark: pgfId-1903789]To add a host profile qualification:
 
    [bookmark: pgfId-3074696]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1903790]Step 1 Select Policies > Correlation, then select the Rule Management tab.
 
    [bookmark: pgfId-3267506]The Rule Management page appears.
 
    [bookmark: pgfId-3267545]Step 2 Click Create Rule.
 
    [bookmark: pgfId-3267566]The Create Rule page appears.
 
    [bookmark: pgfId-3268250]Step 3 On the Create Rule page, click Add Host Profile Qualification.
 
    [bookmark: pgfId-1903791]The Host Profile Qualification section appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-1903796]Tip To remove a host profile qualification, click Remove Host Profile Qualification.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1903797]Step 4 Build the host profile qualification’s conditions.
 
    [bookmark: pgfId-1903798]You can create a single, simple condition, or you can create more elaborate constructs by combining and nesting conditions. See Understanding Rule Building Mechanics for information on how to use the web interface to build conditions. 
 
    [bookmark: pgfId-1903807]The syntax you can use to build conditions is described in Syntax for Host Profile Qualifications.
 
    [bookmark: pgfId-1903810]Step 5 [bookmark: 85726]Optionally, continue with the procedures in the following sections:
 
     
      
      	 [bookmark: pgfId-1903814]Constraining Correlation Rules Using Connection Data Over Time
 
      	 [bookmark: pgfId-3085433]Adding a User Qualification
 
      	 [bookmark: pgfId-1903818]Adding Snooze and Inactive Periods
 
     
 
    
 
    [bookmark: pgfId-3087420]If you are finished building the correlation rule, continue with step 9 of the procedure in Creating Rules for Correlation Policies to save the rule.
 
   
 
    
     [bookmark: pgfId-1903820][bookmark: 83498]Syntax fo[bookmark: marker-2276584]r Host Profile Qualifications
 
    [bookmark: pgfId-2977012]License: FireSIGHT
 
    [bookmark: pgfId-1903821]When you build a host profile qualification condition, you must first select the host you want to use to constrain your correlation rule. The host you can choose depends on the type of event you are using to trigger the rule, as follows:
 
     
     	 [bookmark: pgfId-3363620]If you are using a connection event, select  Responder Host or  Initiator Host .
 
     	 [bookmark: pgfId-3363621]If you are using an intrusion event, select  Destination Host or  Source Host .
 
     	 [bookmark: pgfId-3363622]If you are using a discovery event, host input event, or user activity, select  Host .
 
    
 
    [bookmark: pgfId-3149124]After you select the host type, you continue building your host profile qualification condition, as described in the following table.
 
    [bookmark: pgfId-2433425]Note that although you can configure the network discovery policy to add hosts to the network map based on data exported by NetFlow-enabled devices, the available information about these hosts is limited. For example, there is no operating system data available for these hosts, unless you provide it using the host input feature. In addition, if you use connection data exported by NetFlow-enabled devices, keep in mind that NetFlow records do not contain information about which host is the initiator and which is the responder. When the system processes NetFlow records, it uses an algorithm to determine this information based on the ports each host is using, and whether those ports are well-known. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     
      [bookmark: pgfId-1903962]
 
      
       
        
        [bookmark: pgfId-3178675]Table 51-11 [bookmark: 57817]Syntax for Host Profile Qualifications 
 
        
        
         
         	 
           
           [bookmark: pgfId-3178679]If you specify... 
          
  
         	 
           
           [bookmark: pgfId-3178681]Select an operator, then... 
          
  
        
 
         
         	[bookmark: pgfId-3178683]Host Type
  
         	[bookmark: pgfId-3178685]Select one or more host types. You can choose between a host or one of several types of network device.
  
        
 
         
         	[bookmark: pgfId-3466033]NETBIOS Name
  
         	[bookmark: pgfId-3466035]Type the NetBIOS name of the host.
  
        
 
         
         	[bookmark: pgfId-3178692]Operating System > OS Name
  
         	[bookmark: pgfId-3178694]Select one or more operating system names.
  
        
 
         
         	[bookmark: pgfId-3178696]Operating System > OS Vendor
  
         	[bookmark: pgfId-3178698]Select one or more operating system vendor names.
  
        
 
         
         	[bookmark: pgfId-3178700]Operating System > OS Version
  
         	[bookmark: pgfId-3178702]Select one or more operating system versions.
  
        
 
         
         	[bookmark: pgfId-3210531]Hardware
  
         	[bookmark: pgfId-3210533]Type the hardware model for the mobile device. For example, to match all Apple iPhones, type iPhone.
  
        
 
         
         	[bookmark: pgfId-3302755]IOC Tag
  
         	[bookmark: pgfId-3302757]Select one or more IOC tags. For more information on IOC tag types, see Understanding Indications of Compromise Types.
  
        
 
         
         	[bookmark: pgfId-3210595]Jailbroken
  
         	[bookmark: pgfId-3210597]Select Yes to indicate that the host in the event is a jailbroken mobile device or No to indicate that it is not.
  
        
 
         
         	[bookmark: pgfId-3210642]Mobile
  
         	[bookmark: pgfId-3210644]Select Yes to indicate that the host in the event is a mobile device or No to indicate that it is not.
  
        
 
         
         	[bookmark: pgfId-3178704]Network Protocol
  
         	[bookmark: pgfId-3178707]Type the network protocol number as listed in http://www.iana.org/assignments/ethernet-numbers.
  
        
 
         
         	[bookmark: pgfId-3178709]Transport Protocol
  
         	[bookmark: pgfId-3178712]Type the name or number of the transport protocol as listed in http://www.iana.org/assignments/protocol-numbers.
  
        
 
         
         	[bookmark: pgfId-3178714]Host Criticality
  
         	[bookmark: pgfId-3178716]Select the host criticality: None, Low, Medium, or High. For more information on host criticality, see Working with the Predefined Host Attributes.
  
        
 
         
         	[bookmark: pgfId-3178721]VLAN ID
  
         	[bookmark: pgfId-3178723]Type the VLAN ID associated with the host.
  
        
 
         
         	[bookmark: pgfId-3178725]Application Protocol >
Application Protocol
  
         	[bookmark: pgfId-3178727]Select one or more application protocols.
  
        
 
         
         	[bookmark: pgfId-3178729]Application Protocol >
Application Port
  
         	[bookmark: pgfId-3178731]Type the application protocol port number.
 [bookmark: pgfId-3178732]If you are using an intrusion event to trigger the correlation rule, depending on the host you chose for the host profile qualification, this field is pre-populated with a port in the event: dst_port (for Destination Host) or src_port (for Source Host).
  
        
 
         
         	[bookmark: pgfId-3178734]Application Protocol >
Protocol
  
         	[bookmark: pgfId-3178736]Select one or more protocols.
  
        
 
         
         	[bookmark: pgfId-3303596]Application Protocol Category
  
         	[bookmark: pgfId-3303598]Select a category.
  
        
 
         
         	[bookmark: pgfId-3178738][bookmark: marker-3222203][bookmark: marker-3222208]Client > Client
  
         	[bookmark: pgfId-3178740]Select one or more clients. 
  
        
 
         
         	[bookmark: pgfId-3178742]Client > Client Version 
  
         	[bookmark: pgfId-3178744]Type the client version.
  
        
 
         
         	[bookmark: pgfId-3303655]Client Category
  
         	[bookmark: pgfId-3303657]Select a category.
  
        
 
         
         	[bookmark: pgfId-3189730]Web Application 
  
         	[bookmark: pgfId-3189732]Select a web application.
  
        
 
         
         	[bookmark: pgfId-3303671]Web Application Category
  
         	[bookmark: pgfId-3303673]Select a category.
  
        
 
         
         	[bookmark: pgfId-3178746]MAC Address > MAC Address
  
         	[bookmark: pgfId-3178748]Type all or part of the MAC address of the host.
 [bookmark: pgfId-3178749]For example, if you know that devices from a certain hardware have MAC addresses that begin with 0A:12:34, you could choose begins with as the operator, then type 0A:12:34 as the value.
  
        
 
         
         	[bookmark: pgfId-3178751]MAC Address > MAC Type
  
         	[bookmark: pgfId-3178753]Select whether the MAC type is ARP/DHCP Detected.
 [bookmark: pgfId-3178754]That is, select whether the system positively identified the MAC address as belonging to the host (is ARP/DHCP Detected), whether the system is seeing many hosts with that MAC address because, for example, there is a router between the managed device and the host (is not ARP/DHCP Detected), or whether the MAC type is irrelevant (is any).
  
        
 
         
         	[bookmark: pgfId-3178756]MAC Vendor > 
MAC Vendor
  
         	[bookmark: pgfId-3178758]Type all or part of the name of the MAC hardware vendor of the host.
  
        
 
         
         	[bookmark: pgfId-3178760]any available host attribute, including the default compliance white list host attribute
  
         	[bookmark: pgfId-3178762]Specify the appropriate value, which depends on the type of host attribute you select:
 
           
           	 [bookmark: pgfId-3178763]If the host attribute type is  Integer , enter an integer value in the range defined for the attribute. 
 
           	 [bookmark: pgfId-3178764]If the host attribute type is  Text , enter a text value.
 
           	 [bookmark: pgfId-3178765]If the host attribute type is  List , select a valid list string. 
 
           	 [bookmark: pgfId-3178766]If the host attribute type is  URL , enter a URL value.
 
          
 [bookmark: pgfId-3178769]For more information on host attributes, see Working with User-Defined Host Attributes.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1947019]Note that you can often use event data when constructing a host profile qualification. For example, assume your correlation rule triggers when the system detects the use of Internet Explorer on one of your monitored hosts. Further assume that when you detect this use, you want to generate an event if the version of the browser is not the latest (for this example, assume the latest version is 9.0).
 
     [bookmark: pgfId-3061092]You could add a host profile qualification to this correlation rule so that the rule triggers only if the Client is the Event Client (that is, Internet Explorer), but the Client Version is not 9.0.
 
    
 
   
 
    
     [bookmark: pgfId-2102746][bookmark: 88816]Constraining Correlation Rules Using [bookmark: marker-2276585]Connection Data Over Time
 
    [bookmark: pgfId-3067421]License: FireSIGHT
 
    [bookmark: pgfId-3326156]A connection tracker constrains a correlation rule so that after the rule’s initial criteria are met (including host profile and user qualifications), the system begins tracking certain connections. The Defense Center generates a correlation event for the rule if the tracked connections meet additional criteria gathered over a time period that you specify.
 
    [bookmark: pgfId-3342375]If you are using a connection, intrusion, discovery, user activity, or host input event to trigger your correlation rule, you can add a connection tracker to the rule. You cannot add a connection tracker to a rule that triggers on a malware event or traffic profile change.
 
     
      
    
 
    
 
    [bookmark: pgfId-3341759]Tip Connection trackers typically monitor very specific traffic and, when triggered, run only for a finite, specified time. Compare connection trackers with traffic profiles, which typically monitor a broad range of network traffic and run persistently; see Creating Traffic Profiles.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3338919]There are two ways a connection tracker can generate an event, depending on how you construct the tracker:
 
    [bookmark: pgfId-3339287]Connection Trackers That Fire Immediately When Conditions Are Met
 
    [bookmark: pgfId-3339052]You can configure a connection tracker so that the correlation rule fires as soon as network traffic meets the tracker’s conditions. When this happens, the system stops tracking connections for this connection tracker instance, even if the timeout period has not expired. If the same type of policy violation that triggered the correlation rule occurs again, the system creates a new connection tracker.
 
    [bookmark: pgfId-3339687]If, on the other hand time expires before network traffic meets the conditions in the connection tracker, the Defense Center does not generate a correlation event, and also stops tracking connections for that rule instance.
 
    [bookmark: pgfId-3339269]For example, a connection tracker can serve as a kind of event threshold by generating a correlation event only if a certain type of connection occurs more than a specific number of times within a specific time period. Or, you can generate a correlation event only if the system detects excessive data transfer after an initial connection.
 
    [bookmark: pgfId-3339324]Connection Trackers That Fire at The End of The Timeout Period
 
    [bookmark: pgfId-3339645]You can configure a connection tracker so that it relies on data collected over the entire timeout period, and therefore cannot fire until the end of the timeout period.
 
    [bookmark: pgfId-3340246]For example, if you configure a connection tracker to fire if you detect fewer than a certain number of bytes being transferred during a certain time period, the system waits until that time period passes and then generates an event if network traffic met that condition.
 
    [bookmark: pgfId-3319881]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-3319939]Adding a Connection Tracker
 
     	 [bookmark: pgfId-3321349]Syntax for Connection Trackers
 
     	 [bookmark: pgfId-3321354]Syntax for Connection Tracker Events
 
     	 [bookmark: pgfId-3321373]Example: Excessive Connections From External Hosts
 
     	 [bookmark: pgfId-3321391]Example: Excessive BitTorrent Data Transfers
 
    
 
   
 
    
     [bookmark: pgfId-3318976][bookmark: 17028]Adding a Connection Tracker
 
    [bookmark: pgfId-3325274]License: FireSIGHT
 
    [bookmark: pgfId-3325637]A connection tracker constrains a correlation rule so that after its initial criteria are met (including host profile and user qualifications), the system begins tracking certain connections. The Defense Center generates a correlation event for the rule if the tracked connections meet additional criteria gathered over a time period that you specify.
 
    [bookmark: pgfId-3325275]When you configure a connection tracker, you must specify:
 
     
     	 [bookmark: pgfId-3323824]which connections you want to track
 
     	 [bookmark: pgfId-3323825]the conditions that the connections you are tracking must meet for the Defense Center to generate a correlation event
 
     	 [bookmark: pgfId-3323829]the maximum duration of the connection tracker, that is, the time period during which the conditions you specify must be met to generate a correlation event
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-3323467]Tip You can add a connection tracker to a simple correlation rule that requires only that any connection, intrusion, discovery, user identity, or host input event occurs.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3318796]To add a connection tracker:
 
    [bookmark: pgfId-3318797]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-3318798]Step 1 On the Create Rule page, click Add Connection Tracker.
 
    [bookmark: pgfId-3318799]The Connection Tracker section appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-3318804]Tip To remove a connection tracker, click Remove Connection Tracker.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3318806]Step 2 [bookmark: 26530]Specify which connections you want to track by setting connection tracker criteria.
 
    [bookmark: pgfId-3318807]You can set connection tracker criteria by creating a single, simple condition, or you can create more elaborate constructs by combining and nesting conditions. 
 
    [bookmark: pgfId-3318811]See Understanding Rule Building Mechanics for information on how to use the web interface to build conditions. The syntax you can use to build connection tracker conditions is described in Syntax for Connection Trackers.
 
    [bookmark: pgfId-3318819]Step 3 [bookmark: 63470]Based on the connections you decided to track in step 2, describe when you want to generate a correlation event.
 
    [bookmark: pgfId-3318820]You can create a single, simple condition that describes when you want to generate an event, or you can create more elaborate constructs by combining and nesting conditions.
 
    [bookmark: pgfId-3318821]You must also specify the interval (in seconds, minutes, or hours) during which the conditions you specify must be met to generate a correlation event.
 
    [bookmark: pgfId-3318825]See Understanding Rule Building Mechanics for information on how to use the web interface to build conditions. The syntax you can use to build connection tracker conditions is described in Syntax for Connection Tracker Events.
 
    [bookmark: pgfId-3085553]Step 4 Optionally, continue with the procedures in the following sections:
 
     
      
      	 [bookmark: pgfId-3085561]Adding a User Qualification
 
      	 [bookmark: pgfId-3085519]Adding Snooze and Inactive Periods
 
     
 
    
 
    [bookmark: pgfId-3087463]If you are finished building the correlation rule, continue with step 9 of the procedure in Creating Rules for Correlation Policies to save the rule.
 
    [bookmark: pgfId-3413999]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1904032][bookmark: 75197]Syntax for[bookmark: marker-2276586] Connection Trackers
 
    [bookmark: pgfId-3067435]License: Any
 
    [bookmark: pgfId-1904036]The following table describes how to build a connection tracker condition that specifies the kind of connections you want to track.
 
    [bookmark: pgfId-2430437]You should keep in mind that connections detected by Cisco managed devices and connection data exported by NetFlow-enabled devices contain different information. For example, connections detected by managed devices do not contain TCP flag information. Therefore, if you want to specify that a connection event have a certain TCP flag to trigger a correlation rule, none of the connections detected by managed devices will trigger the rule. 
 
    [bookmark: pgfId-3325658]As another example, NetFlow records do not contain information about which host in the connection is the initiator and which is the responder. When the system processes NetFlow records, it uses an algorithm to determine this information based on the ports each host is using, and whether those ports are well-known. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     
      [bookmark: pgfId-1904095]
 
      
       
        
        [bookmark: pgfId-3058369]Table 51-12 [bookmark: 75970]Syntax for Connection Trackers 
 
        
        
         
         	 
           
           [bookmark: pgfId-3058373]If you specify... 
          
  
         	 
           
           [bookmark: pgfId-3058375]Select an operator, then... 
          
  
        
 
         
         	[bookmark: pgfId-3363901]Access Control Policy
  
         	[bookmark: pgfId-3363903]Select one or more access control policies that logged the connections you want to track.
  
        
 
         
         	[bookmark: pgfId-3363930]Access Control Rule Action
  
         	[bookmark: pgfId-3363932]Select one or more access control rule actions associated with the access control rule that logged the connections you want to track.
 to track connections that match the conditions of any Monitor rule, regardless of the rule or default action that later handles the connections.
  
        
 
         
         	[bookmark: pgfId-3363975]Access Control Rule Name
  
         	[bookmark: pgfId-3363977]Type all or part of the name of the access control rule that logged the connections you want to track.
 [bookmark: pgfId-3363978]Note To track connections that match Monitor rules, type the name of the Monitor rule. The system tracks the connections, regardless of the rule or default action that later handles them.
  
        
 
         
         	[bookmark: pgfId-3364004]Applica[bookmark: marker-3364003]tion Protocol
  
         	[bookmark: pgfId-3364006]Select one or more application protocols.
  
        
 
         
         	[bookmark: pgfId-3364012]Application Protocol Category
  
         	[bookmark: pgfId-3364014]Select one or more application protocol categories.
  
        
 
         
         	[bookmark: pgfId-3364109][bookmark: marker-3364108]Client
  
         	[bookmark: pgfId-3364111]Select one or more clients. 
  
        
 
         
         	[bookmark: pgfId-3364117]Client Category
  
         	[bookmark: pgfId-3364119]Select one or more client categories.
  
        
 
         
         	[bookmark: pgfId-3364211]Client Version
  
         	[bookmark: pgfId-3364213]Type the version of the client.
  
        
 
         
         	[bookmark: pgfId-3364247]Connection Duration
  
         	[bookmark: pgfId-3364249]Type the connection duration, in seconds.
  
        
 
         
         	[bookmark: pgfId-3364271]Connection Type
  
         	[bookmark: pgfId-3364273]Select whether you want to track connections based on how they were detected: by a Cisco managed device (FireSIGHT) or exported by a NetFlow-enabled device (NetFlow).
  
        
 
         
         	[bookmark: pgfId-3364297]Destination Country or Source Country
  
         	[bookmark: pgfId-3364299]Select one or more countries.
  
        
 
         
         	[bookmark: pgfId-3364403]Device
  
         	[bookmark: pgfId-3364405]Select one or more devices whose detected connections you want to track. If you want to track NetFlow connections, select the devices that process the connection data exported by your NetFlow-enabled devices. 
  
        
 
         
         	[bookmark: pgfId-3364439]Ingress Interface or
Egress Interface
  
         	[bookmark: pgfId-3364441]Select one or more interfaces.
  
        
 
         
         	[bookmark: pgfId-3058377]Ingress Security Zone or
Egress Security Zone
  
         	[bookmark: pgfId-3071095]Select one or more security zones.
  
        
 
         
         	[bookmark: pgfId-3058399]Initiator IP,
Responder IP, or
Initiator/Responder IP
  
         	[bookmark: pgfId-3058401]Type a single IP address or address block. For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
  
        
 
         
         	[bookmark: pgfId-3364475]Initiator Bytes,
Responder Bytes, or
Total Bytes
  
         	[bookmark: pgfId-3364477]Type one of:
 
           
           	 [bookmark: pgfId-3364478]the number of bytes transmitted ( Initiator Bytes )
 
           	 [bookmark: pgfId-3364479]the number of bytes received ( Responder Bytes )
 
           	 [bookmark: pgfId-3364480]the number of bytes both transmitted and received ( Total Bytes )
 
          
  
        
 
         
         	[bookmark: pgfId-3364514]Initiator Packets,
Responder Packets, or
Total Packets
  
         	[bookmark: pgfId-3364516]Type one of:
 
           
           	 [bookmark: pgfId-3364517]the number of packets transmitted ( Initiator Packets )
 
           	 [bookmark: pgfId-3364518]the number of packets received ( Responder Packets )
 
           	 [bookmark: pgfId-3364519]the number of packets both transmitted and received ( Total Packets )
 
          
  
        
 
         
         	[bookmark: pgfId-3272726]Initiator Port/ICMP Type or Responder Port/ICMP Code
  
         	[bookmark: pgfId-3272728]Type the port number or ICMP type for initiator traffic or the port number or ICMP code for responder traffic.
  
        
 
         
         	[bookmark: pgfId-3302681]IOC Tag
  
         	[bookmark: pgfId-3302683]Select whether an IOC tag is or is not set.
  
        
 
         
         	[bookmark: pgfId-3466096]NETBIOS Name
  
         	[bookmark: pgfId-3466098]Type the NetBIOS name of the monitored host in the connection.
  
        
 
         
         	[bookmark: pgfId-3364590]NetFlow Device
  
         	[bookmark: pgfId-3364592]Select the IP address of the NetFlow-enabled device that exported the connections you want to track. If you did not add any NetFlow-enabled devices to your deployment, the NetFlow Device drop-down list is blank.
  
        
 
         
         	[bookmark: pgfId-3364626]Reason
  
         	[bookmark: pgfId-3364628]Select one or more reasons associated with the connections you want to track.
  
        
 
         
         	[bookmark: pgfId-3364646]Security Intelligence Category
  
         	[bookmark: pgfId-3364648]Select one or more Security Intelligence categories associated with the connections you want to track.
  
        
 
         
         	[bookmark: pgfId-3364821]TCP Flags
  
         	[bookmark: pgfId-3364823]Select the TCP flag that connections must contain in order to track them.
 [bookmark: pgfId-3364824]Note Only connections exported by NetFlow-enabled devices contain TCP flag data.
  
        
 
         
         	[bookmark: pgfId-3159872]Transport Protocol
  
         	[bookmark: pgfId-3159874]Type the transport protocol used by the connection: TCP or UDP.
  
        
 
         
         	[bookmark: pgfId-3364858]URL
  
         	[bookmark: pgfId-3364860]Type all or part of the URL visited in the connections you want to track.
  
        
 
         
         	[bookmark: pgfId-3058540]URL Category
  
         	[bookmark: pgfId-3071533]Select one or more URL categories for the URL visited in the connections you want to track.
  
        
 
         
         	[bookmark: pgfId-3058544]URL Reputation
  
         	[bookmark: pgfId-3071535]Select one or more URL reputation values for the URL visited in the connections you want to track
  
        
 
         
         	[bookmark: pgfId-3364894]Username
  
         	[bookmark: pgfId-3364896]Type the username of the user logged into either host in the connections you want to track.
  
        
 
         
         	[bookmark: pgfId-3364931]Web Appli[bookmark: marker-3364930]cation
  
         	[bookmark: pgfId-3364933]Select one or more web applications.
  
        
 
         
         	[bookmark: pgfId-3364951]Web Application Category
  
         	[bookmark: pgfId-3364953]Select one or more web application categories.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1952215][bookmark: 87178]Syntax for[bookmark: marker-2276587] Connection Tracker Events
 
    [bookmark: pgfId-3067449]License: Any
 
    [bookmark: pgfId-1904101]The following table describes how to how to build a connection tracker condition that specifies when you want to generate a correlation event based on the connections you are tracking. 
 
     
      [bookmark: pgfId-1904136]
 
      
       
        
        [bookmark: pgfId-1904105]Table 51-13 [bookmark: 90500]Syntax for Connection Tracker Events 
 
        
        
         
         	 
           
           [bookmark: pgfId-1904109]If you specify... 
          
  
         	 
           
           [bookmark: pgfId-1904111]Select an operator, then... 
          
  
        
 
         
         	[bookmark: pgfId-1904113]Number of Connections
  
         	[bookmark: pgfId-1904115]Type the total number of connections detected.
  
        
 
         
         	[bookmark: pgfId-3377620]Number of SSL Encrypted Sessions
  
         	[bookmark: pgfId-3377622]Type the total number of SSL- or TLS-encrypted sessions detected.
  
        
 
         
         	[bookmark: pgfId-1904117]Total Bytes,
Initiator Bytes, or
Responder Bytes
  
         	[bookmark: pgfId-1904119]Type one of:
 
           
           	 [bookmark: pgfId-1904120]the total bytes transmitted ( Total Bytes )
 
           	 [bookmark: pgfId-1904121]the number of bytes transmitted ( Initiator Bytes )
 
           	 [bookmark: pgfId-1904122]the number of bytes received ( Responder Bytes )
 
          
  
        
 
         
         	[bookmark: pgfId-1904124]Total Packets,
Initiator Packets, or
Responder Packets
  
         	[bookmark: pgfId-1904126]Type one of:
 
           
           	 [bookmark: pgfId-1904127]the total packets transmitted ( Total Packets )
 
           	 [bookmark: pgfId-1904128]the number of packets transmitted ( Initiator Packets )
 
           	 [bookmark: pgfId-1904129]the number of packets received ( Responder Packets )
 
          
  
        
 
         
         	[bookmark: pgfId-1904131]Unique Initiators or 
Unique Responders
  
         	[bookmark: pgfId-1904133]Type one of:
 
           
           	 [bookmark: pgfId-1904134]the number of unique hosts that initiated sessions that were detected ( Unique Initiators )
 
           	 [bookmark: pgfId-1904135]the number of unique hosts that responded to connections that were detected ( Unique Responders )
 
          
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3321077][bookmark: 59120]Example: Excessive Connections From External Hosts
 
    [bookmark: pgfId-3321078]Consider a scenario where you archive sensitive files on network 10.1.0.0/16, and where hosts outside this network typically do not initiate connections to hosts inside the network. An occasional connection initiated from outside the network might occur, but you have determined that when four or more connections are initiated within two minutes, there is cause for concern.
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3321100]In this example, the system detected a connection that met the basic conditions of the correlation rule, that is, the system detected a connection from a host outside the 10.1.0.0/16 network to a host inside the network. This created a connection tracker.
 
    [bookmark: pgfId-3321101]The connection tracker is processed in the following stages:
 
    
 
    [bookmark: pgfId-3321102]Step 1 The system starts tracking connections when it detects a connection from Host A outside the network to Host 1 inside the network.
 
    [bookmark: pgfId-3321103]Step 2 The system detects two more connections that match the connection tracker signature: Host B to Host 2 and Host C to Host 1.
 
    [bookmark: pgfId-3321104]Step 3 The system detects a fourth qualifying connection when Host A connects to Host 3 within the two-minute time limit. The rule conditions are met.
 
    [bookmark: pgfId-3321108]Step 4 The Defense Center generates a correlation event and the system stops tracking connections.
 
    [bookmark: pgfId-3414195]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3321109][bookmark: 20644]Example: Excessive BitTorrent Data Transfers
 
    [bookmark: pgfId-3334357]Consider a scenario where you want to generate a correlation event if the system detects excessive BitTorrent data transfers after an initial connection to any host on your monitored network.
 
    [bookmark: pgfId-3336393]The following graphic shows a correlation rule that triggers when the system detects the BitTorrent application protocol on your monitored network. The rule has a connection tracker that constrains the rule so that the rule triggers only if hosts on your monitored network (in this example, 10.1.0.0/16) collectively transfer more than 7MB of data (7340032 bytes) via BitTorrent in the five minutes following the initial policy violation.
 
    [bookmark: pgfId-3532586]
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3321129]In this example, the system detected the BitTorrent TCP application protocol on two different hosts: Host 1 and Host 2. These two hosts transmitted data via BitTorrent to four other hosts: Host A, Host B, Host C, and Host D.
 
    [bookmark: pgfId-3321131]This connection tracker is processed in the following stages:
 
    
 
    [bookmark: pgfId-3329530]Step 1 The system starts tracking connections at the 0-second marker when the system detects the BitTorrent application protocol on Host 1. 
 
    [bookmark: pgfId-3329628]Note that the connection tracker will expire if the system does not detect 7MB of BitTorrent TCP data being transmitted in the next 5 minutes (by the 300-second marker).
 
    [bookmark: pgfId-3321133]Step 2 At 5 seconds, Host 1 has transmitted 3MB of data that matches the signature:
 
     
      
      	 [bookmark: pgfId-3329614]1MB from Host 1 to Host A, at the 1-second marker (1MB total BitTorrent traffic counted towards fulfilling the connection tracker)
 
      	 [bookmark: pgfId-3329615]2MB from Host 1 to Host B, at the 5-second marker (3MB total)
 
     
 
    
 
    [bookmark: pgfId-3329667]Step 3 At 7 seconds, the system detects the BitTorrent application protocol on Host 2 and starts tracking BitTorrent connections for that host as well.
 
    [bookmark: pgfId-3331514]Step 4 At 20 seconds, the system has detected additional data matching the signature being transmitted from both Host 1 and Host 2:
 
     
      
      	 [bookmark: pgfId-3331563]1MB from Host 2 to Host A, at the 10-second marker (4MB total)
 
      	 [bookmark: pgfId-3331621]2MB from Host 1 to Host C, at the 15-second marker (6MB total)
 
      	 [bookmark: pgfId-3331702]1MB from Host 2 to Host B, at the 20-second marker (7MB total)
 
     
 
    
 
    [bookmark: pgfId-3333725]Although Host 1 and Host 2 have now transmitted a combined 7MB of BitTorrent data, the rule does not trigger because the total number of bytes transmitted must be more than 7MB (Responder Bytes are greater than 7340032).
 
    [bookmark: pgfId-3333726]At this point, if the system were to detect no additional BitTorrent transfers for the remaining 280 seconds in the tracker’s timeout period, the tracker would expire and the Defense Center would not generate a correlation event.
 
    [bookmark: pgfId-3331832]Step 5 However, at 30 seconds, the system detects another BitTorrent transfer:
 
     
      
      	 [bookmark: pgfId-3331717]2MB from Host 1 to Host D at the 30-second marker (9MB total)
 
     
 
    
 
    [bookmark: pgfId-3332882]The rule conditions are met. 
 
    [bookmark: pgfId-3333625]Step 6 The Defense Center generates a correlation event.
 
    [bookmark: pgfId-3333695]The Defense Center also stops tracking connections for this connection tracker instance, even though the 5-minute period has not expired. If the system detects a new connection using the BitTorrent TCP application protocol at this point, it will create a new connection tracker.
 
    [bookmark: pgfId-3333689]Note that the Defense Center generates the correlation event after Host 1 transmits the entire 2MB to Host D, because it does not tally connection data until the session terminates.
 
    [bookmark: pgfId-3414393]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2397104][bookmark: 27199]Adding a User Qu[bookmark: marker-2468167]alification
 
    [bookmark: pgfId-2977106]License: FireSIGHT
 
    [bookmark: pgfId-2407982]If you are using a connection, intrusion, discovery, or host input event to trigger your correlation rule, you can constrain the rule based on the identity of a user involved in the event. This constraint is called a user qualification. You cannot add a user qualification to a correlation rule that triggers on a traffic profile change or on the detection of user activity.
 
    [bookmark: pgfId-3363609]For example, you could constrain a correlation rule so that it triggers only when the identity of the source or destination user is one from the sales department.
 
    [bookmark: pgfId-3363610]To add a user identity qualification:
 
    [bookmark: pgfId-3074743]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-2408007]Step 1 On the Create Rule page, click Add User Qualification.
 
    [bookmark: pgfId-2408008]The User Identity Qualification section appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-2408013]Tip To remove a user qualification, click Remove User Qualification.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2408014]Step 2 Build the user qualification’s conditions.
 
    [bookmark: pgfId-2408015]You can create a single, simple condition, or you can create more elaborate constructs by combining and nesting conditions. See Understanding Rule Building Mechanics for information on how to use the web interface to build conditions. 
 
    [bookmark: pgfId-2408021]The syntax you can use to build conditions is described in Syntax for User Qualifications.
 
    [bookmark: pgfId-3087194]Step 3 Optionally, continue with Adding Snooze and Inactive Periods.
 
    [bookmark: pgfId-3087211]If you are finished building the correlation rule, continue with step 9 of the procedure in Creating Rules for Correlation Policies to save the rule.
 
    [bookmark: pgfId-3414409]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3087198][bookmark: 85720]Syntax fo[bookmark: marker-3087197]r User Qualifications
 
    [bookmark: pgfId-2977126]License: FireSIGHT
 
    [bookmark: pgfId-2408060]When you build a user qualification condition, you must first select the identity you want to use to constrain your correlation rule. The identity you can choose depends on the type of event you are using to trigger the rule, as follows:
 
     
     	 [bookmark: pgfId-2408061]If you are using a connection event, select  Identity on Initiator  or  Identity on Responder .
 
     	 [bookmark: pgfId-3363601]If you are using an intrusion event, select  Identity on Destination  or  Identity on Source .
 
     	 [bookmark: pgfId-3363602]If you are using a discovery event, select  Identity on Host .
 
     	 [bookmark: pgfId-2408074]If you are using a host input event, select  Identity on Host .
 
    
 
    [bookmark: pgfId-2408075]After you select the user type, you continue building your user qualification condition, as described in the following table.
 
    [bookmark: pgfId-2874159]The Defense Center obtains certain information about users, including first and last names, department, telephone number, and email address, from an optional Defense Center-LDAP server connection; see Using User Agents to Report Active Directory Logins. This information may not be available for all users in the database.
 
     
      [bookmark: pgfId-2408186]
 
      
       
        
        [bookmark: pgfId-3459180]Table 51-14 [bookmark: 78552]Syntax for User Qualifications 
 
        
        
         
         	 
           
           [bookmark: pgfId-3459184]If you specify... 
          
  
         	 
           
           [bookmark: pgfId-3459186]Select an operator, then... 
          
  
        
 
         
         	[bookmark: pgfId-3459188]Username
  
         	[bookmark: pgfId-3459190]Type the username of the user you want to use to constrain the correlation rule.
  
        
 
         
         	[bookmark: pgfId-3459192]Authentication Protocol
  
         	[bookmark: pgfId-3459194]Select an authentication protocol (or user type) protocol. This is the protocol that was used to detect the user.
  
        
 
         
         	[bookmark: pgfId-3459196]First Name
  
         	[bookmark: pgfId-3459198]Type the first name of the user you want to use to constrain the correlation rule.
  
        
 
         
         	[bookmark: pgfId-3459200]Last Name
  
         	[bookmark: pgfId-3459202]Type the last name of the user you want to use to constrain the correlation rule.
  
        
 
         
         	[bookmark: pgfId-3459204]Department
  
         	[bookmark: pgfId-3459206]Type the department of the user you want to use to constrain the correlation rule.
  
        
 
         
         	[bookmark: pgfId-3459208]Phone
  
         	[bookmark: pgfId-3459210]Type the telephone number of the user you want to use to constrain the correlation rule.
  
        
 
         
         	[bookmark: pgfId-3459212]Email
  
         	[bookmark: pgfId-3459214]Type the email address of the user you want to use to constrain the correlation rule.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2097101][bookmark: 31626]Adding Snooze[bookmark: marker-2276588] and Inactive Periods
 
    [bookmark: pgfId-3067466]License: Any
 
    [bookmark: pgfId-2097102]You can configure snooze periods in correlation rules. When a correlation rule triggers, a snooze period instructs the Defense Center to stop firing that rule for a specified interval, even if the rule is violated again during the interval. When the snooze period has elapsed, the rule can trigger again (and start a new snooze period). 
 
    [bookmark: pgfId-2218837]For example, you may have a host on your network that should never generate traffic. A simple correlation rule that triggers whenever the system detects a connection involving that host may create multiple correlation events in a short period of time, depending on the network traffic to and from the host. To limit the number of correlation events exposing your policy violation, you can add a snooze period so that the Defense Center generates a correlation event only for the first connection (within a time period that you specify) that the system detects involving that host.
 
    [bookmark: pgfId-1904143]You can also set up inactive periods in correlation rules. During inactive periods, the correlation rule will not trigger. You can set up inactive periods to recur daily, weekly, or monthly. For example, you might perform a nightly Nmap scan on your internal network to look for host operating system changes. In that case, you could set a daily inactive period on the affected correlation rules for the time and duration of your scan so that those rules do not trigger erroneously.
 
    [bookmark: pgfId-3532631]The following graphic shows a portion of a correlation rule that is configured with a snooze period and an inactive period.
 
     
      [bookmark: pgfId-3532635]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1922953]To add a snooze per[bookmark: marker-2588341]iod:
 
     [bookmark: pgfId-3074758]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904150]Step 1 On the Create Profile page, under Rule Options, specify the interval that the Defense Center should wait to trigger a rule again, after the rule triggers.
 
      
       
     
 
     
 
     [bookmark: pgfId-1904154]Tip To remove a snooze period, specify an interval of 0 (seconds, minutes, or hours).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1904155]To add an inactive per[bookmark: marker-2588340]iod:
 
     [bookmark: pgfId-3074773]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904156]Step 1 On the Create Profile page, under Rule Options, click Add Inactive Period.
 
     [bookmark: pgfId-1904157]Step 2 Using the drop-down lists and text field, specify when and how often you want the Defense Center to refrain from evaluating network traffic against the correlation rule.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-3149774]When you are finished adding snooze and inactive periods, continue with step 9 of the procedure in Creating Rules for Correlation Policies to save the rule.
 
    [bookmark: pgfId-3414433]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3149780][bookmark: 58151]Understanding[bookmark: marker-3149779] Rule Building Mechanics
 
    [bookmark: pgfId-3149781]License: Any
 
    [bookmark: pgfId-1904171]You build correlation rules, connection trackers, user qualifications, and host profile qualifications by specifying the conditions under which they trigger. You can create simple conditions, or you can create more elaborate constructs by combining and nesting conditions.
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-3363591] 
     Caution Evaluating complex correlation rules that trigger on frequently occurring events can degrade Defense Center performance. For example, a multi-condition rule that the Defense Center must evaluate against every connection logged by the system can cause resource overload. 
      
      
 
     
 
    
 
    [bookmark: pgfId-3363598]For more information on condition building, see:
 
     
     	 [bookmark: pgfId-1904191]Building a Single Condition
 
     	 [bookmark: pgfId-1904195]Adding and Linking Conditions
 
     	 [bookmark: pgfId-1904199]Using Multiple Values in a Condition
 
    
 
   
 
    
     [bookmark: pgfId-1904201][bookmark: 83231]Building a Single Condition
 
    [bookmark: pgfId-3067496]License: Any
 
    [bookmark: pgfId-1904202]Most conditions have three parts: a category, an operator, and a value; some conditions are more complex and contain several categories, each of which may have their own operators and values.
 
    [bookmark: pgfId-3088258]For example, the following correlation rule triggers if a new host is detected on the 10.4.x.x network. The category of the condition is IP Address, the operator is is in, and the value is 10.4.0.0/16.
 
     
      [bookmark: pgfId-3120807]
 
     [bookmark: pgfId-3532733]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1923421]To build the correlation rule trigger criteria in the example above:
 
     [bookmark: pgfId-3074796]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904210]Step 1 Begin building a correlation rule.
 
     [bookmark: pgfId-1904213]For more information, see Creating Rules for Correlation Policies.
 
     [bookmark: pgfId-1904215]Step 2 On the Create Rule page, under Select the type of event for this rule, select a discovery event occurs, then select a new IP host is detected from the drop-down list.
 
     [bookmark: pgfId-1904216]Step 3 Start building the rule’s single condition by selecting IP Address from the first (or category) drop-down list.
 
     [bookmark: pgfId-1904217]Step 4 Select is in from the operator drop-down list that appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-2932836]Tip When the category represents an IP address, choosing is in or is not in as the operator allows you to specify whether the IP address is in or is not in a block of IP addresses, as expressed in special notation such as CIDR. For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1904222]Step 5 Type 10.4.0.0/16 in the text field.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1904232]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3436909]To build the host profile qualification in the example above:
 
     [bookmark: pgfId-3074813]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904233]Step 1 Build a correlation rule that triggers on an discovery event.
 
     [bookmark: pgfId-1904236]For more information, see Creating Rules for Correlation Policies.
 
     [bookmark: pgfId-1904238]Step 2 On the Create Rule page, click Add Host Profile Qualification.
 
     [bookmark: pgfId-1904239]The Host Profile Qualification section appears.
 
     [bookmark: pgfId-1904244]Step 3 Under Host Profile Qualification, in the first condition, specify the host whose host profile you want to use to constrain your correlation rule.
 
     [bookmark: pgfId-1904245]Because this host profile qualification is part of a correlation rule based on an discovery event, the only available category is Host.
 
     [bookmark: pgfId-1904246]Step 4 Begin specifying the details of the operating system of the host by choosing the Operating System category.
 
     [bookmark: pgfId-1904247]Three subcategories appear: OS Vendor, OS Name, and OS Version. 
 
     [bookmark: pgfId-1904248]Step 5 To specify that the host can be running any version of Microsoft Windows, use the same operator for all three subcategories: is.
 
     [bookmark: pgfId-1904249]Step 6 Finally, specify the values for the subcategories.
 
     [bookmark: pgfId-1904250]Select Microsoft as the value for OS Vendor, Windows as the value for OS Name, and leave any as the value for OS Version.
 
     [bookmark: pgfId-3414924]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3088341]Note that the categories you can choose from depend on whether you are building correlation rule triggers, a host profile qualification, a connection tracker, or a user qualification. Within correlation rule triggers, the categories further depend on what kind of event is the basis for your correlation rule. 
 
     [bookmark: pgfId-3088342]In addition, a condition’s available operators depend on the category you choose. Finally, the syntax you can use to specify a condition’s value depends on the category and operator. Sometimes you must type the value in a text field. Other times, you can pick a value from a drop-down list.
 
      
       
     
 
     
 
     [bookmark: pgfId-1904253]Note Where the condition syntax allows you to pick a value from a drop-down list, you can often use multiple values from the list. For more information, see Using Multiple Values in a Condition.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1904257]For more information on the syntax for building correlation rule trigger criteria, see:
 
      
      	 [bookmark: pgfId-3088328]Syntax for Intrusion Events
 
      	 [bookmark: pgfId-3088332]Syntax for Malware Events
 
      	 [bookmark: pgfId-3174566]Syntax for Discovery Events
 
      	 [bookmark: pgfId-3088336]Syntax for User Activity Events
 
      	 [bookmark: pgfId-2399030]Syntax for Host Input Events
 
      	 [bookmark: pgfId-3057787]Syntax for Connection Events
 
      	 [bookmark: pgfId-1904273]Syntax for Traffic Profile Changes
 
     
 
     [bookmark: pgfId-2409979]For more information on the syntax for building host profile qualifications, user qualifications, and connection trackers, see:
 
      
      	 [bookmark: pgfId-2409983]Syntax for Host Profile Qualifications
 
      	 [bookmark: pgfId-2409976]Syntax for Connection Trackers
 
      	 [bookmark: pgfId-2409959]Syntax for Connection Tracker Events
 
      	 [bookmark: pgfId-3088295]Syntax for User Qualifications
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1904288][bookmark: 59566]Adding and[bookmark: marker-2276590] Linking Conditions
 
    [bookmark: pgfId-3067509]License: Any
 
    [bookmark: pgfId-2409934]You can create simple correlation rule triggers, connection trackers, host profile qualifications, and user qualifications, or you can create more elaborate constructs by combining and nesting conditions.
 
    [bookmark: pgfId-1904290]When your construct includes more than one condition, you must link them with an AND or an OR operator. Conditions on the same level are evaluated together:
 
     
     	 [bookmark: pgfId-1904291]The  AND operator requires that all conditions on the level it controls must be met.
 
     	 [bookmark: pgfId-1904292]The  OR operator requires that at least one of the conditions on the level it controls must be met.
 
    
 
    [bookmark: pgfId-1904293]For example, the following correlation rule trigger criteria contains two conditions, linked by OR. This means that the rule triggers if either condition is true, that is, if a host with an IP address is not in the 10.x.x.x subnet or if a host transmits an IGMP message.
 
    [bookmark: pgfId-3532768]
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1904304]This rule triggers if SSH is detected on a non-standard port; the first two conditions demand that the application protocol name is SSH and the port is not 22. The rule further requires that the IP address of the host involved in the event is in either the 10.4.x.x network or the 192.168.x.x network.
 
    [bookmark: pgfId-1904305]Logically, the rule is evaluated as follows:
 
     
     [bookmark: pgfId-1904306](A and B and (C or D)) 
    
 
     
      [bookmark: pgfId-1904328]
 
      
       
        
        [bookmark: pgfId-2498005]Table 51-15 Rule Evaluation 
 
        
        
         
         	 
           
           [bookmark: pgfId-1904309]Where... 
          
  
         	 
           
           [bookmark: pgfId-1904311]Is the condition that states... 
          
  
        
 
         
         	[bookmark: pgfId-1904313]A
  
         	[bookmark: pgfId-1904315]Application Protocol is SSH
  
        
 
         
         	[bookmark: pgfId-1904317]B
  
         	[bookmark: pgfId-1904319]Application Port is not 22
  
        
 
         
         	[bookmark: pgfId-1904321]C
  
         	[bookmark: pgfId-1904323]IP Address is in 10.4.0.0/8
  
        
 
         
         	[bookmark: pgfId-1904325]D
  
         	[bookmark: pgfId-1904327]IP Address is in 196.168.0.0/16
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1904329]To add a single condition:
 
     [bookmark: pgfId-3074830]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904330]Step 1 To add a single condition, click Add condition above the current condition.
 
     [bookmark: pgfId-1904331]A new condition is added below the current set of conditions, on the same level as the current set of conditions. By default, it is linked to the conditions on the same level with the OR operator, though you can change the operator to AND. 
 
     [bookmark: pgfId-1904332]For example, if you add a simple condition to the following rule:
 
     [bookmark: pgfId-3532816]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3415068]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1904342]To add a complex condition:
 
     [bookmark: pgfId-3074871]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904343]Step 1 Click Add complex condition above the current condition.
 
     [bookmark: pgfId-1926338]A complex condition is added below the current set of conditions. The complex condition comprises two subconditions, which are linked to each other with the opposite operator from the one used to link the conditions on the level above it.
 
     [bookmark: pgfId-1926339]For example, if you add a complex condition to the following rule:
 
     [bookmark: pgfId-3532864]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3415092]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1904355]To link conditions:
 
     [bookmark: pgfId-3074894]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904356]Step 1 Use the drop-down list to the left of a set of conditions. Choose:
 
      
      	 [bookmark: pgfId-1904357]the  AND operator to require that all conditions on the level it controls be met
 
      	 [bookmark: pgfId-1904358]the  OR operator to require that only one of the conditions on the level it controls be met
 
     
 
     [bookmark: pgfId-3415138]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1952508][bookmark: 86560]Using[bookmark: marker-2276591] Multiple Values in a Condition
 
    [bookmark: pgfId-3067548]License: Any
 
    [bookmark: pgfId-1904361]When you are building a condition, and the condition syntax allows you to pick a value from a drop-down list, you can often use multiple values from the list. For example, if you want to add a host profile qualification to a rule that requires that a host be running some flavor of UNIX, instead of constructing multiple conditions linked with the OR operator, use the following procedure.
 
    [bookmark: pgfId-1904362]To include multiple values in one condition:
 
    [bookmark: pgfId-3074911]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-1904363]Step 1 Build a condition, choosing is in or is not in as the operator.
 
    [bookmark: pgfId-1904364]The drop-down list changes to a text field.
 
    [bookmark: pgfId-1904369]Step 2 Click anywhere in the text field or on the Edit link.
 
    [bookmark: pgfId-1904370]A pop-up window appears.
 
    [bookmark: pgfId-1904375]Step 3 Under Available, use Ctrl or Shift while clicking to select multiple values. You can also click and drag to select multiple adjacent values.
 
    [bookmark: pgfId-1904376]Step 4 Click the right arrow (>) to move the selected entries to Selected.
 
    [bookmark: pgfId-1904377]Step 5 Click OK.
 
    [bookmark: pgfId-1904378]The Create Rule page appears again. Your selections appear in the value field of your condition.
 
    [bookmark: pgfId-3415549]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1952562][bookmark: 40419]Managing Rules for[bookmark: marker-2276592] Correlation Policies
 
    [bookmark: pgfId-3067562]License: Any
 
    [bookmark: pgfId-1904387]Use the Rule Management page to manage correlation rules used within correlation policies. You can create, modify, and delete rules. You can also create rule groups to help you organize correlation rules. For more information on modifying rules, deleting rules, and creating rule groups, see:
 
     
     	 [bookmark: pgfId-1904396]Modifying a Rule
 
     	 [bookmark: pgfId-1904400]Deleting a Rule
 
     	 [bookmark: pgfId-1904404]Creating a Rule Group
 
    
 
    [bookmark: pgfId-1904411]For more information on creating rules, see Creating Rules for Correlation Policies.
 
     
      [bookmark: pgfId-1904414][bookmark: 62308]Modifying a[bookmark: marker-2276593] Rule
 
     [bookmark: pgfId-3067579]License: Any
 
     [bookmark: pgfId-1904415]Use the following procedure to modify an existing correlation rule.
 
     [bookmark: pgfId-1904416]To modify an existing rule:
 
     [bookmark: pgfId-3074928]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-3110785]Step 1 Select Policies > Correlation, then select the Rule Management tab.
 
     [bookmark: pgfId-3110786]The Rule Management page appears.
 
     [bookmark: pgfId-3110787]Step 2 If the rule is in a rule group, click the group name to expand the group.
 ). 
     
 
     [bookmark: pgfId-1904421]The Create Rule page appears.
 
     [bookmark: pgfId-1904422]Step 4 Make modifications as necessary and click Save.
 
     [bookmark: pgfId-1904423]The rule is updated.
 
     [bookmark: pgfId-3415585]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1904425][bookmark: 86561]Deleting a[bookmark: marker-2276594] Rule
 
     [bookmark: pgfId-3067592]License: Any
 
     [bookmark: pgfId-1904426]You cannot delete correlation rules that you are using in one or more correlation policies; you must first delete the rule from all policies in which it is included. For information on deleting a rule from a policy, see Editing a Correlation Policy.
 
     [bookmark: pgfId-1904430]To delete an existing rule:
 
     [bookmark: pgfId-3110819]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-3110820]Step 1 Select Policies > Correlation, then select the Rule Management tab.
 
     [bookmark: pgfId-3110821]The Rule Management page appears.
 
     [bookmark: pgfId-1904433]Step 2 If the rule is in a rule group, click the group name to expand the group.
 ). 
     
 
     [bookmark: pgfId-3066608]Step 4 Confirm that you want to delete the rule.
 
     [bookmark: pgfId-1904435]The rule is deleted.
 
     [bookmark: pgfId-3415597]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1904438][bookmark: 34338]Creating a[bookmark: marker-2276595] Rule Group
 
     [bookmark: pgfId-3067605]License: Any
 
     [bookmark: pgfId-1904443]Create rule groups to help you organize correlation rules. The FireSIGHT System ships with many default rules, which are grouped according to function. For example, the Worms rule group comprises rules that detect activity by common worms. Note that rule groups exist only to help you organize correlation rules; you cannot assign a group of rules to a correlation policy. Instead, add each rule individually.
 
     [bookmark: pgfId-1904444]You can add a rule to an existing group when you create the rule. You can also modify an existing rule to add it to a group. For more information, see the following sections:
 
      
      	 [bookmark: pgfId-1904448]Creating Rules for Correlation Policies 
 
      	 [bookmark: pgfId-3066959]Modifying a Rule 
 
     
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1904457]To create a rule group:
 
    [bookmark: pgfId-3109944]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-3109945]Step 1 Select Policies > Correlation, then select the Rule Management tab.
 
    [bookmark: pgfId-3109946]The Rule Management page appears.
 
    [bookmark: pgfId-3109896]Step 2 Click Create Group.
 
    [bookmark: pgfId-1904461]The Create Group page appears.
 
    [bookmark: pgfId-1904466]Step 3 In the Group Name field, type a name for the group.
 
    [bookmark: pgfId-1904467]Step 4 Click Add Group.
 
    [bookmark: pgfId-1904468]The group is added.
 
    [bookmark: pgfId-3415643]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3105347][bookmark: 59292]Grouping Correlation Res[bookmark: marker-3105345]ponses
 
    [bookmark: pgfId-3105352]License: Any
 
    [bookmark: pgfId-3106745]After you create alert responses and remediations, (see Working with Alert Responses and Creating Remediations), you can group them so that a policy violation triggers all of the responses within the group. Before you can assign response groups to correlation rules, you must create the groups on the Groups page.
 
    [bookmark: pgfId-3105360]The slider next to the group indicates whether the group is active. If you want to assign a response group to a rule within a correlation policy, you must activate it. You can sort response groups by state (active versus inactive) or alphabetically by name using the Sort by drop-down list.
 
    [bookmark: pgfId-3105365]See the following sections for more information:
 
     
     	 [bookmark: pgfId-3105369]Creating a Response Group
 
     	 [bookmark: pgfId-3105373]Modifying a Response Group
 
     	 [bookmark: pgfId-3105377]Deleting a Response Group
 
     	 [bookmark: pgfId-3105381]Activating and Deactivating Response Groups
 
    
 
     
      [bookmark: pgfId-3105384][bookmark: 14137]Creating a[bookmark: marker-3105383] Response Group
 
     [bookmark: pgfId-3105388]License: Any
 
     [bookmark: pgfId-3105389]You can place individual alerts and remediations in response groups, which can then be assigned to rules within correlation policies so that a group of alerts and remediations can be launched when a policy is violated. After a group has been assigned to rules in active policies, changes to the group and to alerts or remediations within the group are automatically applied to active policies.
 
     [bookmark: pgfId-3105390]To create a response group:
 
     [bookmark: pgfId-3105391]Access: Admin
 
     
 
     [bookmark: pgfId-3105392]Step 1 Select Policies > Correlation, then click Groups.
 
     [bookmark: pgfId-3105393]The Groups page appears.
 
     [bookmark: pgfId-3105394]Step 2 Click Create Group.
 
     [bookmark: pgfId-3105395]The Response Group page appears.
 
     [bookmark: pgfId-3105400]Step 3 In the Name field, type a name for the new group.
 
     [bookmark: pgfId-3105401]Step 4 Select Active to activate the group so that you can use it in response to a correlation policy violation.
 
     [bookmark: pgfId-3105402]Step 5 From the Available Responses list, select the alerts and remediations you want to include in the group.
 
      
       
     
 
     
 
     [bookmark: pgfId-3106680]Tip Hold down the Ctrl key while clicking to select multiple responses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3105404]Step 6 Click > to move alerts and remediations into the group.
 
     [bookmark: pgfId-3105405]Conversely, you can select alerts and remediations from the Responses in Group list and click < to move the alerts out of the response group.
 
     [bookmark: pgfId-3105406]Step 7 Click Save.
 
     [bookmark: pgfId-3105407]The group is created.
 
     [bookmark: pgfId-3415655]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3105410][bookmark: 26959]Modifying a[bookmark: marker-3105409] Response Group
 
     [bookmark: pgfId-3105414]License: Any
 
     [bookmark: pgfId-3105415]Use the following procedure to modify a response group.
 
     [bookmark: pgfId-3105416]To modify a response group:
 
     [bookmark: pgfId-3105417]Access: Admin
 
     
 
     [bookmark: pgfId-3109977]Step 1 Select Policies > Correlation, then click Groups.
 
     [bookmark: pgfId-3105419]The Groups page appears.
 ) next to the group you want to modify. 
     
 
     [bookmark: pgfId-3110018]The Response Group page appears.
 
     [bookmark: pgfId-3105422]Step 3 Make changes as needed and click Save.
 
     [bookmark: pgfId-3105423]If the group is active and in use, the changes you made take effect immediately.
 
     [bookmark: pgfId-3415671]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3105426][bookmark: 14229]Deleting a[bookmark: marker-3105425] Response Group
 
     [bookmark: pgfId-3105430]License: Any
 
     [bookmark: pgfId-3105431]You can delete a response group if it is not used in a correlation policy. Deleting a response group does not delete the responses in the group, just their association with each other.
 
     [bookmark: pgfId-3105432]To delete a response group:
 
     [bookmark: pgfId-3105433]Access: Admin
 
     
 
     [bookmark: pgfId-3110383]Step 1 Select Policies > Correlation, then click Groups.
 
     [bookmark: pgfId-3110384]The Groups page appears.
 ) next to the group you want to delete. 
     
 
     [bookmark: pgfId-3110225]Step 3 Confirm that you want to delete the group.
 
     [bookmark: pgfId-3110226]The group is deleted.
 
     [bookmark: pgfId-3415704]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3105440][bookmark: 48964]Activating and[bookmark: marker-3105439] Deactivating Response Groups
 
     [bookmark: pgfId-3105444]License: Any
 
     [bookmark: pgfId-3105445]You can temporarily deactivate a response group without deleting it. This leaves the group on the system but does not launch it when a policy to which the group is assigned is violated. Note that if a response group is used in a correlation policy when you deactivate it, it is still considered in use even though it is deactivated; you cannot delete in-use response groups.
 
     [bookmark: pgfId-3110439]To activate or deactivate a response group:
 
     [bookmark: pgfId-3110440]Access: Admin
 
     
 
     [bookmark: pgfId-3110490]Step 1 Select Policies > Correlation, then click Groups.
 
     [bookmark: pgfId-3110491]The Groups page appears.
 
     [bookmark: pgfId-3110443]Step 2 Next to the response group you want to activate or deactivate, click the slider.
 
     [bookmark: pgfId-3110444]If the group was activated, it is deactivated. If it was deactivated, it is activated.
 
     [bookmark: pgfId-3415739]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1904480][bookmark: 63320]Creating [bookmark: marker-2276597]Correlation Policies
 
    [bookmark: pgfId-3067619]License: Any
 
    [bookmark: pgfId-2219047]After you create correlation rules or compliance white lists (or both), and, optionally, alert responses and remediations, you can use them to build correlation policies.
 
    [bookmark: pgfId-2219740]When your network traffic meets the criteria specified in a correlation rule or white list in an active policy, the Defense Center generates either a correlation event or white list event. It also launches any responses you assigned to the rule or white list. You can map each rule or white list to a single response or to a group of responses. If the network traffic triggers multiple rules or white lists, the Defense Center launches all the responses associated with each rule and white list.
 
    [bookmark: pgfId-2219833]For more information on creating the correlation rules, compliance white lists, and responses you can use to build a correlation policy, see the following sections:
 
     
     	 [bookmark: pgfId-2178535]Creating Rules for Correlation Policies
 
     	 [bookmark: pgfId-2219992]Creating Compliance White Lists
 
     	 [bookmark: pgfId-3105230]Configuring External Alerting
 
     	 [bookmark: pgfId-3105188]Configuring Remediations
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2220218]Tip Optionally, create a skeleton policy and modify it later to add rules and responses.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1904497]To create a correlation policy:
 
    [bookmark: pgfId-3110923]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-3110924]Step 1 Select Policies > Correlation.
 
    [bookmark: pgfId-3110925]The Policy Management page appears.
 
    [bookmark: pgfId-1904504]Step 2 Click Create Policy.
 
    [bookmark: pgfId-1904505]The Create Policy page appears.
 
    [bookmark: pgfId-1904510]Step 3 Provide basic policy information, such as the name and description.
 
    [bookmark: pgfId-1904514]See Providing Basic Policy Information.
 
    [bookmark: pgfId-1904515]Step 4 Add one or more rules or white lists to the correlation policy.
 
    [bookmark: pgfId-1904519]See Adding Rules and White Lists to a Correlation Policy.
 
    [bookmark: pgfId-1904520]Step 5 Optionally, set rule and white list priorities.
 
    [bookmark: pgfId-1904524]See Setting Rule and White List Priorities.
 
    [bookmark: pgfId-1904525]Step 6 Optionally, add responses to the rules or white lists you added.
 
    [bookmark: pgfId-1904529]See Adding Responses to Rules and White Lists.
 
    [bookmark: pgfId-1904530]Step 7 Click Save.
 
    [bookmark: pgfId-1904531]The policy is saved.
 
     
      
    
 
    
 
    [bookmark: pgfId-1904532]Note You must activate the policy before it can generate correlation and white list events and launch responses to policy violations. For more information, see Managing Correlation Policies.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1904537][bookmark: 49824]Providing Basic Policy Information
 
     [bookmark: pgfId-3067633]License: Any
 
     [bookmark: pgfId-2513025]You must give each policy an identifying name. Optionally, you can add a short description to the policy.
 
     [bookmark: pgfId-1904543]You can also assign a user-defined priority to your policy. If your correlation policy is violated, the resultant correlation events display the priority value you assign to the policy (unless the rule that was triggered has its own priority). 
 
      
       
     
 
     
 
     [bookmark: pgfId-1904547]Note Rule and white list priorities override policy priorities. For more information, see Adding Rules and White Lists to a Correlation Policy.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1904551]To provide basic policy information:
 
     [bookmark: pgfId-3075015]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904552]Step 1 On the Create Policy page, in the Policy Name field, type a name for the policy.
 
     [bookmark: pgfId-1904553]Step 2 In the Policy Description field, type a description for the policy.
 
     [bookmark: pgfId-1904554]Step 3 From the Default Priority drop-down list, select a priority for the policy.
 
     [bookmark: pgfId-1904555]You can select a priority value from 1 to 5, where 1 is highest and 5 is lowest. Or, you can select None to only use the priorities assigned to specific rules.
 
     [bookmark: pgfId-1904558]Step 4 Continue with the procedure in the next section, Adding Rules and White Lists to a Correlation Policy.
 
     [bookmark: pgfId-3415755]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2178581][bookmark: 37789]Adding Rules[bookmark: marker-2276598] and White Lists to a Correlation Policy
 
     [bookmark: pgfId-3067656]License: Any
 
     [bookmark: pgfId-2513046]A correlation policy contains one or more correlation rules or white lists. When any rule or white list in a policy is violated, the system logs an event to the database. If you assigned one or more responses to the rule or white list, those responses are launched.
 
     [bookmark: pgfId-3532909]The following graphic shows a correlation policy composed of a compliance white list and a set of correlation rules, configured with a variety of responses.
 
     [bookmark: pgfId-3532913]z
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1904571]To add rules or white lists to a correlation policy:
 
     [bookmark: pgfId-3075037]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904572]Step 1 On the Create Policy page, click Add Rules.
 
     [bookmark: pgfId-1904573]The Available Rules pop-up appears.
 
     [bookmark: pgfId-1904578]Step 2 Click the appropriate folder name to expand it.
 
     [bookmark: pgfId-1904579]Step 3 Select the rules and white lists that you want to use in the policy and click Add.
 
     [bookmark: pgfId-1904580]The Create Policy page appears again. The rules and white lists you selected populate the policy.
 
     [bookmark: pgfId-1904583]Step 4 Continue with the procedure in the next section, Setting Rule and White List Priorities.
 
     [bookmark: pgfId-3415799]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1904586][bookmark: 38828]Setting Rule and[bookmark: marker-2276599] White List Priorities
 
     [bookmark: pgfId-3067678]License: Any
 
     [bookmark: pgfId-2513070]You can assign a user-defined priority to each correlation rule or compliance white list in your correlation policy. If a rule or white list triggers, the resulting event displays the priority you assign to the rule or white list. On the other hand, if you do not assign a priority value and the rule or white list triggers, the resulting event displays the priority value of the policy.
 
     [bookmark: pgfId-1904588]For example, consider a policy where the policy itself has a priority of 1 and its rules or white lists are set with the default priority, with the exception of one rule given a priority of 3. If the priority 3 rule triggers, the resulting correlation event shows 3 as its priority value. If other rules or white lists in the policy trigger, the resulting events show 1 as their priority values, retained from the policy’s priority.
 
     [bookmark: pgfId-2178639]To set rule or white list priorities:
 
     [bookmark: pgfId-3075055]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2178640]Step 1 On the Create Policy page, from the Priority list for each rule or white list, select a default priority. You can select:
 
      
       
       	 [bookmark: pgfId-1904596]a priority value from 1 to 5, where 1 is highest and 5 is lowest
 
       	 [bookmark: pgfId-1904597] None 
 
       	 [bookmark: pgfId-1904598] Default to use the policy’s default priority
 
      
 
     
 
     [bookmark: pgfId-1904601]Step 2 Continue with the procedure in the next section, Adding Responses to Rules and White Lists.
 
     [bookmark: pgfId-3415811]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1904604][bookmark: 53075]Adding Responses to[bookmark: marker-2276600] Rules and White Lists
 
     [bookmark: pgfId-3105171]License: Any
 
     [bookmark: pgfId-3105172]Within a correlation policy, you can map each rule or white list to a single response or to a group of responses. When any one of the rules or white lists in a policy is violated, the system logs an associated event to the database and launches the responses assigned to that rule or white list. If multiple rules or white lists within a policy trigger, the Defense Center launches the responses associated with each rule or white list. 
 
     [bookmark: pgfId-3106356]For more information on creating responses and response groups, see:
 
      
      	 [bookmark: pgfId-3106367]Configuring External Alerting
 
      	 [bookmark: pgfId-3106411]Configuring Remediations
 
      	 [bookmark: pgfId-3106393]Grouping Correlation Responses
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1918649]Note Do not assign an Nmap remediation as a response to a correlation rule that triggers on a traffic profile change. The remediation will not launch.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3532918]The following graphic shows a correlation policy composed of a compliance white list and a set of correlation rules, configured with a variety of responses.
 
     [bookmark: pgfId-3532922]z
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1904620]To add responses to rules and white lists:
 
     [bookmark: pgfId-3075082]Access: Admin/Discovery Admin
 
     
 ). 
     
 
     [bookmark: pgfId-1904622]A pop-up window appears.
 
     [bookmark: pgfId-1904627]Step 2 Under Unassigned Responses, select the response, multiple responses, or response group you want to launch when the rule or white list triggers, and click the up arrow.
 
      
       
     
 
     
 
     [bookmark: pgfId-1965892]Tip Hold down the Ctrl key while clicking to select multiple responses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1904629]Step 3 Click Update.
 
     [bookmark: pgfId-1904630]The Create Policy page appears again. The responses you specified are added to the rule or white list.
 
     [bookmark: pgfId-3415827]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2513286][bookmark: 46389]Managing [bookmark: marker-2513285]Correlation Policies
 
    [bookmark: pgfId-3067739]License: Any
 
    [bookmark: pgfId-2513292]You manage correlation policies on the Policy Management page. You can create, modify, sort, activate, deactivate, and delete policies.
 
    [bookmark: pgfId-1904640]The slider next to the policy indicates whether the group is active. If you want the policy to generate correlation events and white list events, you must activate it. You can sort policies by state (active versus inactive) or alphabetically by name using the Sort by drop-down list.
 
    [bookmark: pgfId-2245638]If an active correlation policy contains a compliance white list, the following actions do not delete the host attribute associated with the white list, nor do they change that host attribute’s values:
 
     
     	 [bookmark: pgfId-2245886]deactivating the policy
 
     	 [bookmark: pgfId-2245887]modifying the policy to remove the white list
 
     	 [bookmark: pgfId-2245888]deleting the policy 
 
    
 
    [bookmark: pgfId-2245885]That is, hosts that were compliant when you performed the action still appear as compliant on the host attributes network map, and so on. To delete the host attribute, you must delete its corresponding white list.
 
    [bookmark: pgfId-2245937]To update the white list compliance of the hosts on your network, you must either reactivate the correlation policy (if you deactivated it) or add the white list to another active correlation policy (if you deleted the white list from a correlation policy or deleted the policy itself). Note that the reevaluation of the white list that occurs when you do this does not generate white list events and therefore does not trigger any responses you associated with the white list. For more information on compliance white lists, see Using the FireSIGHT System as a Compliance Tool.
 
    [bookmark: pgfId-2245736]For more information on managing correlation policies, see:
 
     
     	 [bookmark: pgfId-1904645]Activating and Deactivating Correlation Policies
 
     	 [bookmark: pgfId-1904649]Editing a Correlation Policy
 
     	 [bookmark: pgfId-1904653]Deleting a Correlation Policy
 
    
 
    [bookmark: pgfId-1904656]For information on creating new policies, see Creating Correlation Policies.
 
     
      [bookmark: pgfId-1904659][bookmark: 63092]Activating and[bookmark: marker-2276602] Deactivating Correlation Policies
 
     [bookmark: pgfId-3067752]License: Any
 
     [bookmark: pgfId-2513318]Use the following procedure to either activate or deactivate a correlation policy.
 
     [bookmark: pgfId-1904661]To activate or deactivate a policy:
 
     [bookmark: pgfId-3075103]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904662]Step 1 Select Policies > Correlation.
 
     [bookmark: pgfId-1904663]The Policy Management page appears.
 
     [bookmark: pgfId-3112118]Step 2 Next to the policy you want to activate or deactivate, click the slider.
 
     [bookmark: pgfId-3112119]If the policy was active, it is deactivated. If it was deactivated, it is activated.
 
     [bookmark: pgfId-3415935]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1904668][bookmark: 26117]Editing a[bookmark: marker-2276603] Correlation Policy
 
     [bookmark: pgfId-3067765]License: Any
 
     [bookmark: pgfId-2514479]Use the following procedure to modify a correlation policy.
 
     [bookmark: pgfId-2514480]To edit a policy:
 
     [bookmark: pgfId-3075116]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2514481]Step 1 Select Policies > Correlation.
 
     [bookmark: pgfId-1904672]The Policy Management page appears.
 ) next to the policy. 
     
 ) next to the rule or white list you want to remove. 
     
 
     [bookmark: pgfId-1951477]Step 3 Make changes as needed and click Save.
 
     [bookmark: pgfId-1951478]The policy is changed. If the policy is active, the changes you made take effect immediately.
 
     [bookmark: pgfId-3415955]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1904681][bookmark: 15599]Deleting a[bookmark: marker-2276606] Correlation Policy
 
     [bookmark: pgfId-3067790]License: Any
 
     [bookmark: pgfId-2246227]Use the following procedure to delete a correlation policy.
 
     [bookmark: pgfId-1904683]To delete a policy:
 
     [bookmark: pgfId-3075129]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1904684]Step 1 Select Policies > Correlation.
 
     [bookmark: pgfId-1904685]The Policy Management page appears.
 ) next to the policy you want to delete. 
     
 
     [bookmark: pgfId-1904687]The policy is deleted.
 
     [bookmark: pgfId-3415967]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2249528][bookmark: 39260]Working with[bookmark: marker-2276609] Correlation Events
 
    [bookmark: pgfId-3067815]License: Any
 
    [bookmark: pgfId-2977843]When a correlation rule within an active correlation policy triggers, the Defense Center generates a correlation event and logs it to the database. For information on configuring the number of correlation events saved in the database, see Configuring Database Event Limits.
 
     
      
    
 
    
 
    [bookmark: pgfId-2269585]Note When a compliance white list within an active correlation policy triggers, the Defense Center generates a white list event. For more information, see Working with White List Events.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1904704]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1904708]Viewing Correlation Events
 
     	 [bookmark: pgfId-2082159]Understanding the Correlation Events Table
 
     	 [bookmark: pgfId-1904712]Searching for Correlation Events
 
    
 
     
      [bookmark: pgfId-1904715][bookmark: 47102]Viewing[bookmark: marker-2276610] Correlation Events
 
     [bookmark: pgfId-3067840]License: Any
 
     [bookmark: pgfId-1904720]You can view a table of correlation events, then manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-1904721]The page you see when you access correlation events differs depending on the workflow you use. You can use the predefined workflow, which includes the table view of correlation events. You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
      
      [bookmark: pgfId-1904739]To... 
     
 
      
      [bookmark: pgfId-1904741]You can... 
     
 
     [bookmark: pgfId-1904743]view the host profile for an IP address
 
     [bookmark: pgfId-1904745]click the host profile icon that appears next to the IP address.
 
     [bookmark: pgfId-2547707]view user profile information
 ) that appears next to the user identity. For more information, see 
     Understanding User Details and Host History. 
     
 
     [bookmark: pgfId-1904747]sort and constrain events on the current workflow page
 
     [bookmark: pgfId-1904751]find more information in Sorting Drill-Down Workflow Pages.
 
     [bookmark: pgfId-1904754]navigate within the current workflow page
 
     [bookmark: pgfId-1904758]find more information in Navigating to Other Pages in the Workflow.
 
     [bookmark: pgfId-1904761]navigate between pages in the current workflow, keeping the current constraints
 
     [bookmark: pgfId-1904763]click the appropriate page link at the top left of the workflow page. For more information, see Using Workflow Pages.
 
     [bookmark: pgfId-1904768]learn more about the columns that appear
 
     [bookmark: pgfId-1904772]find more information in Understanding the Correlation Events Table.
 
     [bookmark: pgfId-1904775]modify the time and date range for displayed events
 
     [bookmark: pgfId-1904779]find more information in see Setting Event Time Constraints.
 
     [bookmark: pgfId-2573568]Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.
 
     [bookmark: pgfId-2427206]drill down to the next page in the workflow, constraining on a specific value
 
     [bookmark: pgfId-2573339]use one of the following methods:
 
      
      	 [bookmark: pgfId-2573340]on a drill-down page that you created in a custom workflow, click  a value within a row. Note that clicking a value within a row in a table view constrains the table view and does  not drill down to the next page.
 
      	 [bookmark: pgfId-2573341]To drill down to the next workflow page constraining on some users, select the check boxes next to the users you want to view on the next workflow page, then click  View .
 
      	 [bookmark: pgfId-2573342]To drill down to the next workflow page keeping the current constraints, click  View All .
 
     
 
     [bookmark: pgfId-2427209]Tip Table views always include “Table View” in the page name. 
    
 
    [bookmark: pgfId-2427212]For more information, see Constraining Events.
 
    [bookmark: pgfId-1904793]delete correlation events from the system
 
    [bookmark: pgfId-1904795]use one of the following methods:
 
     
     	 [bookmark: pgfId-1904796]To delete some events, select the check boxes next to the events you want to delete, then click  Delete .
 
     	 [bookmark: pgfId-1904797]To delete all events in the current constrained view, click  Delete All , then confirm you want to delete all the events.
 
    
 
    [bookmark: pgfId-1904816]navigate to other event views to view associated events
 
    [bookmark: pgfId-1904821]find more information in Navigating Between Workflows.
 
   
 
   [bookmark: pgfId-3075164]To view correlation events:
 
   [bookmark: pgfId-3075165]Access: Admin/Any Security Analyst
 
   
 
   [bookmark: pgfId-3075166]Step 1 Select Analysis > Correlation > Correlation Events.
 
   [bookmark: pgfId-2550887]The first page of the default correlation events workflow appears. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
    
     
   
 
   
 
   [bookmark: pgfId-2550894]Tip If you are using a custom workflow that does not include the table view of correlation events, click (switch workflow), then select Correlation Events.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-3415979]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-2042165]Understanding [bookmark: 43510]the[bookmark: marker-2276611] Correlation Events Table
 
    [bookmark: pgfId-3067857]License: Any
 
    [bookmark: pgfId-2221118]When a correlation rule triggers, the Defense Center generates a correlation event. The fields in the correlation events table[bookmark: marker-2276612] are described in the following table.
 
     
      [bookmark: pgfId-2221091]
 
      
       
        
        [bookmark: pgfId-3179500]Table 51-17 [bookmark: 61763]Correlation Event Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-3179504]Field 
          
  
         	 
           
           [bookmark: pgfId-3179506]Description 
          
  
        
 
         
         	[bookmark: pgfId-3179508]Time
  
         	[bookmark: pgfId-3179510]The date and time that the correlation event was generated.
  
        
 
         
         	[bookmark: pgfId-3179512]Impact
  
         	[bookmark: pgfId-3179514]The impact level assigned to the correlation event based on the correlation between intrusion data, discovery data, and vulnerability information. For more information, see Using Impact Levels to Evaluate Events.
  
        
 
         
         	[bookmark: pgfId-3179519]Inline Result
  
         	[bookmark: pgfId-3179521]One of:
 
           
           	 [bookmark: pgfId-3179522]a black down arrow, indicating that the system dropped the packet that triggered the intrusion rule
 
           	 [bookmark: pgfId-3179523]a gray down arrow, indicating that the system would have dropped the packet in an inline, switched, or routed deployment if you enabled the  Drop when Inline intrusion policy option
 
           	 [bookmark: pgfId-3179524]blank, indicating that the triggered intrusion rule was not set to Drop and Generate Events
 
          
 [bookmark: pgfId-3179525]Note that the system does not drop packets in a passive deployment, including when an inline set is in tap mode, regardless of the rule state or the drop behavior of the intrusion policy.
  
        
 
         
         	[bookmark: pgfId-3179539]Source IP or
Destination IP
  
         	[bookmark: pgfId-3179541]The IP address of the source or destination host in the event that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3367959]Source Country or Destination Country
  
         	[bookmark: pgfId-3367961]The country associated with the source or destination IP address in the event that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3366465]Security Intelligence Category
  
         	[bookmark: pgfId-3366467]The name of the blacklisted object that represents or contains the blacklisted IP address in the event that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3179543]Source User or
Destination User
  
         	[bookmark: pgfId-3179545]The name of the user logged in to the source or destination host in the event that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3179547]Source Port/ICMP Type or Destination Port/ICMP Code
  
         	[bookmark: pgfId-3179549]The source port or ICMP type for the source traffic or the destination port or ICMP code for destination traffic associated with the event that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3179551]Description
  
         	[bookmark: pgfId-3179553]The description of the correlation event. The information in the description depends on how the rule was triggered. 
 [bookmark: pgfId-3179554]For example, if the rule was triggered by an operating system information update event, the new operating system name and confidence level appears.
  
        
 
         
         	[bookmark: pgfId-3179556]Policy
  
         	[bookmark: pgfId-3179558]The name of the policy that was violated.
  
        
 
         
         	[bookmark: pgfId-3179560]Rule
  
         	[bookmark: pgfId-3179562]The name of the rule that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3179564]Priority
  
         	[bookmark: pgfId-3179566]The priority specified by the policy or rule that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3179568]Source Host Criticality or Destination Host Criticality
  
         	[bookmark: pgfId-3363567]The user-assigned host criticality of the source or destination host involved in the correlation event: None, Low, Medium, or High. 
 [bookmark: pgfId-3179571]Note that only correlation events generated by rules based on discovery events, host input events, or connection events contain a source host criticality. For more information on host criticality, see Working with the Predefined Host Attributes.
  
        
 
         
         	[bookmark: pgfId-3179576]Ingress Security Zone or
Egress Security Zone
  
         	[bookmark: pgfId-3179578]The ingress or egress security zone in the intrusion or connection event that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3179580]Device
  
         	[bookmark: pgfId-3179582]The name of the device that generated the event that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3179584]Ingress Interface or
Egress Interface
  
         	[bookmark: pgfId-3179586]The ingress or egress interface in the intrusion or connection event that triggered the policy violation.
  
        
 
         
         	[bookmark: pgfId-3179588]Count
  
         	[bookmark: pgfId-3179590]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2221092]For more information on displaying the correlation events table, see the following:
 
      
      	 [bookmark: pgfId-2284714]Viewing Correlation Events
 
      	 [bookmark: pgfId-2284718]Searching for Correlation Events
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1904874][bookmark: 20081]Searching for[bookmark: marker-2276613] Correlation Events
 
    [bookmark: pgfId-3067878]License: Any
 
     
     [bookmark: pgfId-3132530]Field 
    
 
     
     [bookmark: pgfId-3132532]Search Criteria Rules 
    
 
    [bookmark: pgfId-3132534]Policy
 
    [bookmark: pgfId-3132536]Type the name of the correlation policy you want to search for.
 
    [bookmark: pgfId-3132538]Rule
 
    [bookmark: pgfId-3132540]Type the name of the correlation rule you want to search for.
 
    [bookmark: pgfId-3132542]Description
 
    [bookmark: pgfId-3132544]Type all or part of the correlation event description. The information in the description depends on the event that caused the rule to trigger.
 
    [bookmark: pgfId-3132546]Priority
 
    [bookmark: pgfId-3132548]Specify the priority of the correlation event, which is determined by the priority of either the triggered rule or the violated correlation policy. Enter none for no priority. For information on setting correlation rule and policy priorities, see Providing Basic Policy Information and Setting Rule and White List Priorities.
 
    [bookmark: pgfId-3368157]Source Country,
Destination Country, or
Source/Destination Country
 
    [bookmark: pgfId-3368159]Specify the country associated with the source, destination, or source or destination host IP addresses in the event that triggered the policy violation.
 
    [bookmark: pgfId-3368432]Source Continent,
Destination Continent, or
Source/Destination Continent
 
    [bookmark: pgfId-3368434]Specify the continent associated with the source, destination, or source or destination host IP addresses in the event that triggered the policy violation.
 
    [bookmark: pgfId-3368701]Security Intelligence Category
 
    [bookmark: pgfId-3368703]Specify the Security Intelligence category associated with the correlation event that triggered the policy violation. The Security Intelligence category can be the name of a Security Intelligence object, the global blacklist, a custom Security Intelligence list or feed, or one of the categories in the Intelligence Feed. For more information, see Blacklisting Using Security Intelligence IP Address Reputation.
 
    [bookmark: pgfId-3132556]Source IP,
Destination IP, or
Source/Destination IP
 
    [bookmark: pgfId-3132558]Specify the IP address of the source, destination, or source or destination hosts in the event that triggered the policy violation. You can specify a single IP address or address block, or a comma-separated list of either or both. You can also use negation. See Specifying IP Addresses in Searches for more information.
 
    [bookmark: pgfId-3132560]Source User or
Destination User
 
    [bookmark: pgfId-3132562]Specify the user logged in to the source or destination host in the event that triggered the policy violation.
 
    [bookmark: pgfId-3179711]Source Port/ICMP Type or 
Destination Port/ICMP Code
 
    [bookmark: pgfId-3132566]Specify the source port or ICMP type for source traffic or destination port or ICMP code for destination traffic associated with the event that triggered the policy violation.
 
    [bookmark: pgfId-3132568]Impact
 
    [bookmark: pgfId-3197671]Specify the impact assigned to the correlation event. Valid case-insensitive values are Impact 0, Impact Level 0, Impact 1, Impact Level 1, Impact 2, Impact Level 2, Impact 3, Impact Level 3, Impact 4, and Impact Level 4. Do not use impact icon colors or partial strings (for example, do not use blue, level 1, or 0). For more information, see Using Impact Levels to Evaluate Events.
 
    [bookmark: pgfId-3132575]Inline Result
 
    [bookmark: pgfId-3132577]For policy violations triggered by intrusion events, type either:
 
     
     	 [bookmark: pgfId-3132578] dropped , to specify whether the packet was dropped in an inline, switched, or routed deployment
 
     	 [bookmark: pgfId-3132579] would have dropped , to specify whether the packet would have dropped if the intrusion policy had been set to drop packets in an inline, switched, or routed deployment
 
    
 
    [bookmark: pgfId-3132580]Note that the system does not drop packets in a passive deployment, including when an inline set is in tap mode, regardless of the rule state or the drop behavior of the intrusion policy.
 
    [bookmark: pgfId-3132591]Source Host Criticality or
Destination Host Criticality
 
    [bookmark: pgfId-3132593]Specify the host criticality of the source or destination host involved in the policy violation: None, Low, Medium, or High. Note that only correlation events generated by rules based on discovery events, host input events, or connection events contain a source host criticality. For more information on host criticality, see Working with the Predefined Host Attributes.
 
    [bookmark: pgfId-3132598]Ingress Security Zone,
Egress Security Zone, or 
Ingress/Egress Security Zone
 
    [bookmark: pgfId-3132600]Specify the ingress, egress, or ingress or egress security zone in the intrusion or connection event that triggered the policy violation.
 
    [bookmark: pgfId-3132602]Device
 
    [bookmark: pgfId-3132604]Type the device name or IP address, or a device group, stack, or cluster name to restrict the search to specific devices that generated events that triggered a policy violation. For more information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
 
    [bookmark: pgfId-3132606]Ingress Interface or
Egress Interface
 
    [bookmark: pgfId-3132608]Specify the ingress or egress interface in the intrusion or connection event that triggered the policy violation.
 
   
 
   [bookmark: pgfId-3132630]To search for correlation events:
 
   [bookmark: pgfId-3132611]Access: Admin/Any Security Analyst 
 
   
 
   [bookmark: pgfId-3067968]Step 1 Select Analysis > Search.
 
   [bookmark: pgfId-3067969]The Search page appears.
 
   [bookmark: pgfId-1905072]Step 2 Select Correlation Events from the table drop-down list.
 
   [bookmark: pgfId-3067999]The page updates with the appropriate constraints.
 
   [bookmark: pgfId-1905073]Step 3 Enter your search criteria in the appropriate fields, as described in the Correlation Event Search Criteria table:
 
    
     
     	 [bookmark: pgfId-3132363]All fields accept negation ( ! ).
 
     	 [bookmark: pgfId-3471999]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
     	 [bookmark: pgfId-3472000]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
    
 
   
 
   [bookmark: pgfId-3472001] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
   [bookmark: pgfId-3472002] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
   [bookmark: pgfId-3472003] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
    
     
     	 [bookmark: pgfId-3472004]Searches return only records that match the search criteria specified for all fields.
 
     	 [bookmark: pgfId-3132365]Many fields accept one or more asterisks ( * ) as wild cards. 
 
     	 [bookmark: pgfId-3132366]Specify  n/a in any field to identify events where information is not available for that field; use  !n/a to identify the events where that field is populated.
 
     	 [bookmark: pgfId-3132370]Click the add object icon (
 
    
 
    [image: ] ) that appears next to a search field to use an object as a search criterion. 
   
 
   [bookmark: pgfId-3132371]For more information on search syntax, including using objects in searches, see Searching for Events.
 
   [bookmark: pgfId-1905081]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
    
     
   
 
   
 
   [bookmark: pgfId-3069308]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-1905083]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
    
     
     	 [bookmark: pgfId-3472058]Click  Save to save the search criteria.
 
    
 
   
 
   [bookmark: pgfId-3472059]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
    
     
     	 [bookmark: pgfId-3472060]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
    
 
   
 
   [bookmark: pgfId-3472061]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
   [bookmark: pgfId-1905084]Step 6 Click Search to start the search.
 
   [bookmark: pgfId-2550991]Your search results appear in the default correlation events workflow, constrained by the current time range. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. 
 
   [bookmark: pgfId-3415991]
 
    
    
 
   
 
   
 
   [bookmark: pgfId-1901220]
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1057574][bookmark: 54017]Using the FireSIGHT System as a[bookmark: marker-1156370] Compliance Tool 
      
      
 
     
 
 
    [bookmark: pgfId-1120272]A compliance white list (or white list) is[bookmark: marker-1156371] a set of criteria that allows you to specify the operating systems, applications, and protocols that are allowed to run on a specific subnet, and automatically generate an event if a host on the subnet violates the white list. For example, your security policy might state that while your web servers are allowed to run HTTP, none of the other hosts on your network are. You could create a white list that evaluates your entire network, excluding your web farm, to determine which hosts are running HTTP.
 
    [bookmark: pgfId-1254311]Note that you could create a correlation rule that performs this function by configuring the rule so that it triggers when:
 
     
     	 [bookmark: pgfId-1254315]the system discovers new information about an application protocol
 
     	 [bookmark: pgfId-1254316]the application protocol name is http
 
     	 [bookmark: pgfId-1254320]the IP address of the host involved in the event is not in your web farm
 
    
 
    [bookmark: pgfId-1642675]However, correlation rules, which provide you with a more flexible way of alerting you and responding to policy violations on your network, are more complex to configure and maintain than white lists. Correlation rules are also wider in scope, allowing you to generate a correlation event when one of many types of event meets any criteria that you specify. On the other hand, white lists are specifically meant to help you evaluate the operating systems, application protocols, clients, web applications, and protocols that are running on your network and whether that violates your organization’s policies.
 
    [bookmark: pgfId-1642664]You can create custom white lists that meet your specific needs, or you can use the default white list created by the Cisco Vulnerability Research Team (VRT) that contains recommended settings for allowed operating systems, application protocols, clients, web applications, and protocols. You may also want to customize the default white list for your network environment. 
 
    [bookmark: pgfId-1219782]If you add a white list to an active correlation policy, when the system detects that a host is violating the white list, the system logs a white list event — which is a special kind of correlation event — to the database. Further, you can configure the system to trigger responses (remediations and alerts) automatically when it detects a white list violation.
 
     
      
    
 
    
 
    [bookmark: pgfId-1613834]Note Although you can configure the network discovery policy to add hosts and application protocols to the network map based on data exported by NetFlow-enabled devices, the available information about these hosts and application protocols is limited. For example, there is no operating system data available for these hosts, unless you provide it using the host input feature. This may affect the way you build compliance white lists. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1144856]Because the system creates a host attribute for each host that indicates whether it is in compliance with any white lists you create, you can obtain an at-a-glance summary of the compliance of your network. In just a few seconds, you can determine exactly which hosts in your organization are running HTTP in violation of your policy, and take appropriate action.
 
    [bookmark: pgfId-1144897]Then, using the correlation feature, you can configure the system to alert you whenever a host that is not in your web farm starts running HTTP.
 
    [bookmark: pgfId-1217018]In addition, the system allows you to use host profiles to determine whether an individual host is violating any of the white lists you have configured, and in which way it is violating the white list. The FireSIGHT System also includes workflows that allow you to view each of the individual white list violations, as well as the number of violations per host.
 
    [bookmark: pgfId-1217805]Finally, you can use the dashboard to monitor recent system-wide compliance activity, including white list events and summary views of the overall white list compliance of your network.
 
    [bookmark: pgfId-1215609]For more information on creating and managing compliance white lists and on interpreting white list events and violations, see the following sections:
 
     
     	 [bookmark: pgfId-1215613]Understanding Compliance White Lists
 
     	 [bookmark: pgfId-1215617]Creating Compliance White Lists
 
     	 [bookmark: pgfId-1065411]Managing Compliance White Lists
 
     	 [bookmark: pgfId-1065472]Working with Shared Host Profiles
 
     	 [bookmark: pgfId-1065525]Working with White List Events
 
     	 [bookmark: pgfId-1201684]Working with White List Violations
 
    
 
    [bookmark: pgfId-1147767]In addition, see the following chapters and sections for more information:
 
     
     	 [bookmark: pgfId-1147819]Creating Correlation Policies explains how to create and configure correlation policies that include compliance white lists, and explains how to assign responses and priorities to the white lists.
 
     	 [bookmark: pgfId-1218536]Using Host Profiles explains how to use a host’s profile to determine whether it is violating any white lists. 
 
     	 [bookmark: pgfId-1218540]Using Dashboards explains how to obtain an at-a-glance view of your current system status, including white list compliance activity.
 
    
 
   
 
    
     [bookmark: pgfId-1218544][bookmark: 10049]Understanding Compliance White[bookmark: marker-1218543] Lists
 
    [bookmark: pgfId-1577635]License: FireSIGHT
 
    [bookmark: pgfId-1221155]A compliance white list is a set of criteria that specify the operating systems, clients, application protocols, web applications, and protocols that are allowed to run on your network. You can create custom white lists that meet your specific needs, or you can use the default white list created by the VRT that contains recommended settings.
 
    [bookmark: pgfId-1221124]Custom white list criteria can be simple; you can specify that only hosts running a certain operating system are allowed. Your criteria can also be complex; you can specify that while all operating systems are allowed, only hosts running a certain operating system are allowed to run a certain application protocol on a specific port.
 
    [bookmark: pgfId-1144033]White lists comprise two main parts: targets and host profiles. The targets are the specific hosts that are evaluated by the white list, while the host profiles specify the operating systems, clients, application protocols, web applications, and protocols that are allowed to run on the targets.
 
    [bookmark: pgfId-1142656]After you create a white list and add it to an active correlation policy, the system evaluates the white list’s targets against its host profiles to determine whether the targets are in compliance with the white list. After this initial evaluation, the system generates a white list event when it detects that a valid target is violating the white list. 
 
    [bookmark: pgfId-1098663]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1098664]Understanding White List Targets explains how white lists only target the hosts that you specify.
 
     	 [bookmark: pgfId-1098669]Understanding White List Host Profiles explains the different kinds of profiles that describe which clients, application protocols, web applications, and protocols are allowed to run on your network.
 
     	 [bookmark: pgfId-1098674]Understanding White List Evaluations explains how the system evaluates the hosts on your network against white lists, and how you can tell which hosts are in compliance and which are not.
 
     	 [bookmark: pgfId-1098679]Understanding White List Violations explains how the system detects and notifies you of white list violations.
 
    
 
     
      [bookmark: pgfId-1098565][bookmark: 22815]Understanding White List[bookmark: marker-1156373] Targets
 
     [bookmark: pgfId-1576588]License: FireSIGHT
 
     [bookmark: pgfId-1695686]When you create a white list, you first specify the portions of your network it applies to. You can use a white list to evaluate all the hosts on your monitored network, or you can restrict the white list to evaluate only certain network segments or even individual hosts. You can further restrict the white list so that it evaluates only hosts that have a certain host attribute or that belong to a certain VLAN. A host that is eligible to be evaluated by a white list is called a valid target (or target). A valid target:
 
      
      	 [bookmark: pgfId-1695687]must be in one of the IP address blocks you specify. You can also exclude blocks of IP addresses.
 
      	 [bookmark: pgfId-1093561]must have at least one of the host attributes you specify. 
 
     
 
     [bookmark: pgfId-1105767]For example, you could configure a white list to evaluate only hosts that have a high host criticality. For information on host attributes, including host criticality, see Working with User-Defined Host Attributes and Working with the Predefined Host Attributes. 
 
      
      	 [bookmark: pgfId-1093562]must belong to one of the VLANs you specify.
 
     
 
     [bookmark: pgfId-1093563]If a host does not meet all of these criteria, it is not evaluated against the white list, regardless of whether its host profile is in violation of the white list.
 
     [bookmark: pgfId-1106470]If your white list contains more than one target, a host must meet the criteria specified in only one of them to be considered valid. For example, if you create a target that includes the 10.10.x.x network and one that excludes the 10.10.x.x network, a host in that network is considered a valid target. Note that if your white list does not contain any targets, none of the hosts on your network will be evaluated against the white list.
 
     [bookmark: pgfId-1105687]The target networks for your white list are listed on the left of the Create White List page. Note that the default white list uses targets of 0.0.0.0/0 and ::/0, which represent the entire monitored network. If you choose to use this white list, you can leave the target network as-is or modify it to reflect your network environment.
 
     [bookmark: pgfId-1221199]For information on creating white list targets, see Configuring Compliance White List Targets.
 
    
 
     
      [bookmark: pgfId-1098571][bookmark: 92406]Understanding White List Host[bookmark: marker-1156374] Profiles
 
     [bookmark: pgfId-1576616]License: FireSIGHT
 
     [bookmark: pgfId-1082644]After you specify which targets the white list evaluates, the next step is to configure host profiles. Host profiles in a white list specify which operating systems, clients, application protocols, web applications, and protocols are allowed to run on the target hosts.
 
     [bookmark: pgfId-1103777]There are three kinds of host profiles you can configure in a white list: global host profiles, host profiles for specific operating systems, and shared host profiles. Each type of host profile appears differently when you are creating a white list.
 
      
      [bookmark: pgfId-1104183]To view... 
     
 
      
      [bookmark: pgfId-1104185]Under Allowed Host Profiles, click... 
     
 
     [bookmark: pgfId-1104187]the global host profile for the white list
 
     [bookmark: pgfId-1104189]Any Operating System
 
     [bookmark: pgfId-1104268]a host profile for a specific operating system
 
     [bookmark: pgfId-1104270]a host profile name that is listed in plain text rather than italics
 
     [bookmark: pgfId-1104191]a shared host profile used by the white list
 
     [bookmark: pgfId-1104193]a host profile name that is listed in italics
 
    
 
    [bookmark: pgfId-1103649]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1098826]Understanding the Global Host Profile
 
     	 [bookmark: pgfId-1098846]Understanding Host Profiles for Specific Operating Systems
 
     	 [bookmark: pgfId-1116360]Understanding Shared Host Profiles
 
    
 
   
 
    
     [bookmark: pgfId-1116363][bookmark: 44086]Understanding the[bookmark: marker-1156375] Global Host Profile
 
    [bookmark: pgfId-1576644]License: FireSIGHT
 
    [bookmark: pgfId-1098232]Every white list contains a global host profile, which specifies the application protocols, clients, web applications, and protocols that are allowed to run on target hosts, regardless of the host’s operating system.
 
    [bookmark: pgfId-1101030]For example, instead of editing multiple Microsoft Windows and Linux host profiles to allow Internet Explorer, you can configure the global host profile to allow it regardless of the operating system on which it was detected. Note that the ARP, IP, TCP, and UDP protocols are always allowed to run on every host; you cannot disallow them. For more information, see Configuring the Global Host Profile.
 
   
 
    
     [bookmark: pgfId-1098751][bookmark: 54388]Understanding Host Prof[bookmark: marker-1368452]iles for Specific Operating Systems
 
    [bookmark: pgfId-1576672]License: FireSIGHT
 
    [bookmark: pgfId-1100111]You must create one host profile for each operating system you want to allow on your network. To disallow an operating system on your network, do not create a host profile for that operating system. For example, to make sure that all the hosts on your network are running Microsoft Windows, configure the white list to only contain host profiles for that operating system.
 
    [bookmark: pgfId-1614595]When you create a host profile for an operating system, you can also require that it have a particular version. For example, you could require that compliant hosts run Windows 7 or Server 2008 R2.
 
    [bookmark: pgfId-1614596]After you create a host profile for a particular operating system, you can specify the application protocols, clients, web applications, and protocols that are allowed to run on target hosts running that operating system. For example, you could allow SSH to run on Linux hosts on port 22. You could also restrict the particular vendor and version to OpenSSH 4.2.
 
    [bookmark: pgfId-1143385]Note that unidentified hosts remain in compliance with all white lists until they are identified. You can, however, create a white list host profile for unknown hosts.
 
     
      
    
 
    
 
    [bookmark: pgfId-1143386]Note Unidentified hosts are not the same as unknown hosts. Unidentified hosts are hosts about which the system has not yet gathered enough information to identify their operating systems. Unknown hosts are hosts whose traffic has been analyzed by the system, but whose operating systems do not match any of the known fingerprints.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1611192]For more information, see Creating Host Profiles for Specific Operating Systems.
 
   
 
    
     [bookmark: pgfId-1611196][bookmark: 45207]Understanding Shared [bookmark: marker-1611195]Host Profiles
 
    [bookmark: pgfId-1611200]License: FireSIGHT
 
    [bookmark: pgfId-1150969]Shared host profiles are tied to specific operating systems, but you can use each shared host profile in more than one white list. That is, if you create multiple white lists but want to use the same host profile to evaluate hosts running a particular operating system across the white lists, use a shared host profile.
 
    [bookmark: pgfId-1614675]For example, if you have offices worldwide and you want to create a separate white list for each location, but always want to use the same profile for all hosts running Apple Mac OS X, you can create a shared profile for that operating system and use it in all your white lists.
 ). 
    
 
    [bookmark: pgfId-1245213]Built-in host profiles use built-in application protocols, protocols, and clients. You can use these elements as-is in both the default white list and in any custom white list that you create or you can modify them to suit your needs. They are displayed in italics within the built-in host profile and in any other host profile that uses them.
 
    [bookmark: pgfId-1615020]Keep in mind that like all shared host profiles, if you modify a built-in host profile, it affects every white list that uses it. Likewise, if you modify a built-in application protocol, protocol, or client, it affects every white list that uses it.
 
    [bookmark: pgfId-1244889]For more information on shared host profiles, Working with Shared Host Profiles.
 
   
 
    
     [bookmark: pgfId-1098589][bookmark: 85388]Understanding White List[bookmark: marker-1156377] Evaluations
 
    [bookmark: pgfId-1576716]License: FireSIGHT
 
    [bookmark: pgfId-1084285]After you create white list host profiles and save the white list, you can add the white list to a correlation policy, just as you would a correlation rule. For more information, see Configuring Correlation Policies and Rules.
 
    [bookmark: pgfId-1094307]After you activate the correlation policy, the system evaluates the targets of the white list against the white list criteria.You can then use the host attributes network map to gain an overall view of the white list compliance of the hosts on your network.
 
    [bookmark: pgfId-1094089]Every host on the network is assigned a host attribute that has the same name as the white list. This host attribute has one of the following values:
 
     
     	 [bookmark: pgfId-1094090] Compliant , for valid targets that are compliant with the white list
 
     	 [bookmark: pgfId-1094091] Non-Compliant , for valid targets that violate the white list
 
     	 [bookmark: pgfId-1094092] Not Evaluated , for invalid targets and hosts that have not yet been evaluated for any reason
 
    
 
    [bookmark: pgfId-1213171]Note that if your network is large and the system is in the process of evaluating all the valid targets in the network map against the white list, targets that have not yet been evaluated are marked as Not Evaluated. As the system completes its processing, more hosts move from Not Evaluated to either Compliant or Non-Compliant. The system can evaluate approximately 100 hosts per second.
 
    [bookmark: pgfId-1096111]Additionally, a host may be marked as Not Evaluated if the system has insufficient information to determine whether the host is in compliance. For example, this may occur if the system has detected a new host but has not yet gathered relevant information on the operating system, clients, application protocols, web applications, or protocols running on the host.
 
     
      
    
 
    
 
    [bookmark: pgfId-1213426]Note If you change or delete a host attribute from a host and that change or deletion means that the host is no longer a valid target, the host changes from either Compliant or Non-Compliant to Not Evaluated.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1099683]For more information on host attributes, see Working with the Host Attributes Network Map.
 
   
 
    
     [bookmark: pgfId-1142707][bookmark: 47708]Understanding White List[bookmark: marker-1156378] Violations
 
    [bookmark: pgfId-1576736]License: FireSIGHT
 
    [bookmark: pgfId-1142711]After the initial white list evaluation, the system generates a white list event when it detects that a valid target is violating the white list. White list events are a special kind of correlation event, and are logged to the Defense Center correlation event database. You can view white list events in a workflow, or search for specific white list events. For more information, see Working with White List Events.
 
    [bookmark: pgfId-1089191]White list violations occur when the system generates an event that indicates that a host is out of compliance. Similarly, discovery events may indicate that a previously non-compliant host is now compliant, although the system does not generate a white list event when this occurs. 
 
    [bookmark: pgfId-1222922]The following events can change the compliance of a host:
 
     
     	 [bookmark: pgfId-1093282]the system detects a change in a host’s operating system
 
     	 [bookmark: pgfId-1485440]the system detects an identity conflict for a host’s operating system or an application protocol on the host
 
     	 [bookmark: pgfId-1093286]the system detects a new TCP server port (for example, a port used by SMTP or web servers) active on a host, or a new UDP server running on a host
 
     	 [bookmark: pgfId-1091228]the system detects a change in a discovered TCP or UDP server running on a host, for example, a version change due to an upgrade
 
     	 [bookmark: pgfId-1091232]the system detects a new client running on a host
 
     	 [bookmark: pgfId-1091236]the system drops a client from its database due to inactivity
 
     	 [bookmark: pgfId-1645596]the system detects a new web application running on a host
 
     	 [bookmark: pgfId-1645597]the system drops a web application from a host profile due to inactivity
 
     	 [bookmark: pgfId-1091240]the system detects that a host is communicating with a new network protocol, such as Novell Netware or IPv6, or a new transport protocol, such as ICMP or EGP
 
     	 [bookmark: pgfId-1657267]the system detects a new mobile device that is jailbroken
 
     	 [bookmark: pgfId-1657637]the system detects that a TCP or UDP port has closed or timed out on a host
 
    
 
    [bookmark: pgfId-1657269]In addition, you can trigger a compliance change for a host by using the host input feature or the host profile to:
 
     
     	 [bookmark: pgfId-1222106]add a client, protocol, or server to a host
 
     	 [bookmark: pgfId-1222118]delete a client, protocol, or server from a host
 
     	 [bookmark: pgfId-1222125]set the operating system definition for a host
 
     	 [bookmark: pgfId-1222162]change a host attribute for a host so that the host is no longer a valid target
 
    
 
    [bookmark: pgfId-1091115]For example, if your white list specifies that only Microsoft Windows hosts are allowed on your network, and the system detects that the host is now running Mac OS X, the system generates a white list event. In addition, the host attribute associated with the white list changes its value from Compliant to Non-Compliant for that host.
 
    [bookmark: pgfId-1089199]For the host in this example to come back into compliance, one of the following must occur:
 
     
     	 [bookmark: pgfId-1222072]you edit the white list so that the Mac OS X operating system is allowed
 
     	 [bookmark: pgfId-1222080]you manually change the operating system definition of the host to Microsoft Windows
 
     	 [bookmark: pgfId-1222089]the system detects that the operating system has changed back to Microsoft Windows
 
    
 
    [bookmark: pgfId-1222085]In any case, the host attribute associated with the white list changes its value from Non-Compliant to Compliant for that host.
 
    [bookmark: pgfId-1143078]As another example, if your compliance white list disallows the use of FTP, and you then delete FTP from the application protocols network map or from an event view, hosts running FTP become compliant. However, if the system detects the application protocol again, the system generates a white list event and the hosts become non-compliant.
 
    [bookmark: pgfId-1222828]Note that if the system generates an event that contains insufficient information for the white list, the white list does not trigger. For example, consider a scenario where your white list specifies that you allow only TCP FTP traffic on port 21. Then, the system detects that port 21, using the TCP protocol, has become active on one of the white list targets, but the system is unable to determine whether the traffic is FTP. In this scenario, the white list does not trigger until either the system identifies the traffic as something other than FTP traffic or you use the host input feature to designate the traffic as non-FTP traffic.
 
     
      
    
 
    
 
    [bookmark: pgfId-1729203]Note During the initial evaluation of a white list, the system does not generate white list events for non-compliant hosts. If you want to generate white list events for all non-compliant targets, you must purge the Defense Center database. This causes the hosts on your network and their associated clients, application protocols, web applications, and protocols to be rediscovered, which may trigger white list events. For more information, see Purging Discovery Data from the Database.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1729210]Finally, you can configure the system to trigger responses automatically when it detects a white list violation. Responses include remediations (such as running an Nmap scan), alerts (email, SNMP, and syslog alerts), or combination of alerts and remediations. For more information, see Adding Responses to Rules and White Lists.
 
   
 
    
     [bookmark: pgfId-1309962][bookmark: 54425]Creating Compliance White[bookmark: marker-1309961] Lists
 
    [bookmark: pgfId-1576756]License: FireSIGHT
 
    [bookmark: pgfId-1101475]When you create a white list, you can survey either your entire network or a specific network segment. Surveying the network populates the white list with one host profile for each operating system that the system has detected on the network segment. By default, these host profiles allow all of the clients, application protocols, web applications, and protocols that the system has detected on the applicable operating systems.
 
    [bookmark: pgfId-1101784]Then, you must specify the targets of the white list. You can configure a white list to evaluate all the hosts on your monitored network, or you can restrict the white list to evaluate only certain network segments or even individual hosts. You can further restrict the white list so that it evaluates only hosts that have a certain host attribute or that belong to a certain VLAN. If you surveyed your network, by default the network segment that you surveyed represents the white list targets. You can edit or delete the surveyed network, or you can add new targets. 
 
    [bookmark: pgfId-1101880]Next, create host profiles that represent compliant hosts. Host profiles in a white list specify which operating systems, clients, application protocols, web applications, and protocols are allowed to run on the target hosts. You can configure the global host profile, edit the host profiles created by any network survey your performed, as well as add new host profiles, and add and edit shared host profiles.
 
    [bookmark: pgfId-1101919]Finally, save the white list and add it to an active correlation policy. The system begins evaluating the target hosts for compliance, generating white list events when a host violates the white list, and triggering any responses you have configured to white list violations. For a more detailed introduction to compliance white lists, see Understanding Compliance White Lists.
 
     
      
    
 
    
 
    [bookmark: pgfId-1076216]Tip You can also create a white list from a table view of hosts. For more information, see Creating a Compliance White List Based on Selected Hosts.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1075718]To create a compliance white list:
 
    [bookmark: pgfId-1615574]Access: Admin 
 
    
 
    [bookmark: pgfId-1615575]Step 1 Select Policies > Correlation, then click White List.
 
    [bookmark: pgfId-1615576]The White List page appears.
 
    [bookmark: pgfId-1075843]Step 2 Click New White List.
 
    [bookmark: pgfId-1075876]The Survey Network page appears.
 
    [bookmark: pgfId-1615755]Step 3 Optionally, survey your network:
 
     
      
      	 [bookmark: pgfId-1075919]To survey your network, see Surveying Your Network.
 
      	 [bookmark: pgfId-1075920]To create a white list without surveying your network, click  Skip and continue with the next step.
 
     
 
    
 
    [bookmark: pgfId-1658247]The Create White List page appears.
 
    [bookmark: pgfId-1658640]Step 4 In the Name field, type a name for the new white list.
 
    [bookmark: pgfId-1658641]Step 5 In the Description field, type a short description of the white list.
 
    [bookmark: pgfId-1658645]Step 6 To allow [bookmark: marker-1658642][bookmark: marker-1658643][bookmark: marker-1658644]jailbroken mobile devices on your network, enable Allow Jailbroken Mobile Devices. To cause all jailbroken devices evaluated by the white list to generate a white list violation, disable the option. 
 
    [bookmark: pgfId-1075568]Step 7 Specify the targets for the white list. You can edit or delete the targets created by a network survey as well as add new targets. Optionally, further restrict targets based on host attributes or VLAN ID. For more information, see Configuring Compliance White List Targets.
 
    [bookmark: pgfId-1075648]Step 8 Create host profiles that represent compliant hosts. You can configure the global host profile, edit the host profiles created by a network survey, as well as add new host profiles and add and edit shared host profiles. For more information, see Configuring Compliance White List Host Profiles.
 
    [bookmark: pgfId-1658370]Step 9 Click Save White List to save your white list.
 
    [bookmark: pgfId-1101974]The white list is saved. You can now add it to an active correlation policy to begin evaluating the target hosts for compliance, generating white list events when a host violated the white list, and, optionally triggering responses to white list violations. For more information, see Creating Correlation Policies.
 
    [bookmark: pgfId-1733144]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1059422][bookmark: 42260]Surveying Your[bookmark: marker-1156380] Network
 
     [bookmark: pgfId-1576816]License: FireSIGHT
 
     [bookmark: pgfId-1102124]When you begin creating a compliance white list, you can survey either your entire network or a specific network segment. 
 
     [bookmark: pgfId-1102492]Surveying your network gathers data from the database about the application protocols, clients, web applications, and protocols running on the different detected operating systems. Then, the system creates one host profile within the white list for each detected operating system. By default, these host profiles allow all of the detected clients, application protocols, web applications, and protocols that the system has detected on each applicable operating systems. 
 
     [bookmark: pgfId-1103376]This creates a baseline white list so that you do not have to manually create and configure multiple host profiles. After you survey your network, you can then edit or delete the host profiles that the survey created to suit your needs; you can also add any other host profiles you might need.
 
     [bookmark: pgfId-1111956]Note that you can survey your network at any time during the white list creation process. This can add additional allowed clients, application protocols, web applications, and protocols to the host profiles that already exist, and can create additional host profiles if the survey detects hosts running operating systems that were not detected during the initial survey. If you resurvey your network within a white list that is used within an active correlation policy, and the survey changes either your targets or host profiles, the target hosts are re-evaluated when you save the white list. Although this re-evaluation may bring some hosts into compliance, it does not generate any white list events.
 
     [bookmark: pgfId-1061606]To begin creating a compliance white list by surveying your network:
 
     [bookmark: pgfId-1619149]Access: Admin 
 
     
 
     [bookmark: pgfId-1060559]Step 1 Select Policies > Correlation, then click White List.
 
     [bookmark: pgfId-1060683]The White List page appears.
 
     [bookmark: pgfId-1059562]Step 2 Click New White List.
 
     [bookmark: pgfId-1060761]The Survey Network page appears.
 
     [bookmark: pgfId-1060834]Step 3 Do you want to survey your network?
 
      
       
       	 [bookmark: pgfId-1060885]If  yes , continue with the next step.
 
       	 [bookmark: pgfId-1060889]If  no , click  Skip . 
 
      
 
     
 
     [bookmark: pgfId-1061390]The Create White List page appears and displays a blank white list. Continue with the procedure in the next section, Providing Basic White List Information.
 
     [bookmark: pgfId-1060879]Step 4 [bookmark: 73142]In the IP Address and Netmask fields, enter the IP address and network mask (in special notation such as CIDR) that represent the hosts you want to survey.
 
     [bookmark: pgfId-1068873]Make sure to specify a network that you configured the system to monitor in the network discovery policy. For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1060939]Tip To survey the entire monitored network, use the default values of 0.0.0.0/0 and ::/0.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1060762]Step 5 [bookmark: 31112]Click OK.
 
     [bookmark: pgfId-1060950]The Create White List page appears.
 
     [bookmark: pgfId-1060955]The white list is pre-populated; its targets are the hosts in the network you surveyed and its allowed host profiles are those of the targets.
 
     [bookmark: pgfId-1068271]Step 6 To survey additional networks, click Target Network and repeat steps 4 and 5 for each additional network you want to survey.
 
     [bookmark: pgfId-1102291]Surveying an additional network can add additional allowed clients, application protocols, web applications, and protocols to the host profiles that already exist, and can create additional host profiles if the survey detects hosts running operating systems that were not detected during the initial survey. Surveying an additional network also adds a target to the white list that represents the hosts in the network segment that you surveyed. You can then edit or delete this target.
 
     [bookmark: pgfId-1075991]Step 7 Continue with the next section, Providing Basic White List Information.
 
     [bookmark: pgfId-1732160]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1075986][bookmark: 76331]Providing Basic White List Info[bookmark: marker-1368453]rmation
 
     [bookmark: pgfId-1576836]License: FireSIGHT
 
     [bookmark: pgfId-1311601]You must give each white list a name, and, optionally, a short description. In addition, you can choose whether jailbroken mobile devices should cause a white list violation.
 
     [bookmark: pgfId-1075976]To provide basic white list information:
 
     [bookmark: pgfId-1619170]Access: Admin 
 
     
 
     [bookmark: pgfId-1656453]Step 1 In the Name field, type a name for the new white list.
 
     [bookmark: pgfId-1656454]Step 2 In the Description field, type a short description of the white list.
 
     [bookmark: pgfId-1656465]Step 3 To allow [bookmark: marker-1656824][bookmark: marker-1656829][bookmark: marker-1656834]jailbroken mobile devices on your network, enable Allow Jailbroken Mobile Devices. To cause all jailbroken devices evaluated by the white list to generate a white list violation, disable the option. 
 
     [bookmark: pgfId-1656458]Step 4 Continue with the next section, Configuring Compliance White List Targets.
 
     [bookmark: pgfId-1732240]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059725][bookmark: 60129]Configuring Compliance[bookmark: marker-1156381] White List Targets
 
     [bookmark: pgfId-1576864]License: FireSIGHT
 
     [bookmark: pgfId-1105003]When you create a compliance white list, you must specify the portions of your network it applies to. You can use a white list to evaluate all the hosts on your monitored network, or you can restrict the white list to evaluate only certain network segments or even individual hosts. You can further restrict the white list so that it evaluates only hosts that have a certain host attribute or that belong to a certain VLAN. A host that is eligible to be evaluated by a white list is called a target. For a more detailed introduction to white list targets, see Understanding White List Targets.
 
     [bookmark: pgfId-1117220]When you are finished creating compliance white list targets, continue with Configuring Compliance White List Host Profiles.
 
      
       
     
 
     
 
     [bookmark: pgfId-1222978]Note If you change or delete a host attribute from a host and that modification means that the host is no longer a valid target, the host is no longer evaluated by the white list and is considered neither compliant nor non-compliant.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1069382]For information on how to modify and delete targets, see:
 
      
      	 [bookmark: pgfId-1618726]Modifying Existing Targets
 
      	 [bookmark: pgfId-1069393]Deleting Existing Targets
 
     
 
     [bookmark: pgfId-1611734]When you create a target for a compliance white list, you specify the criteria a host must meet to be evaluated against the white list. A valid target:
 
      
      	 [bookmark: pgfId-1105073]must be in one of the IP address blocks you specify. You can also exclude blocks of IP addresses.
 
      	 [bookmark: pgfId-1105074]must have at least one of the host attributes you specify. 
 
      	 [bookmark: pgfId-1105367]must belong to one of the VLANs you specify.
 
     
 
     [bookmark: pgfId-1106074]Note that if you add a target to a white list that is used by an active correlation policy, after you save the white list, the new target hosts are evaluated for compliance. However, this evaluation does not generate white list events.
 
     [bookmark: pgfId-1061802]To create a compliance white list target:
 
     [bookmark: pgfId-1619190]Access: Admin 
 
     
 ). 
     
 
     [bookmark: pgfId-1061849]The settings for the new target appear.
 
      
       
     
 
     
 
     [bookmark: pgfId-1069705]Tip You can also create a new target by surveying a network segment. On the Create White List page, click Target Network, then follow steps 4 and 5 in Surveying Your Network. The new target is created and is named according to the IP addresses you specified. Click the target you just created and continue with the rest of this procedure to rename the target, add or exclude additional networks, and add host attribute or VLAN restrictions.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1069715]Step 2 In the Name field, type a name for the new target.
 . 
     
 
     [bookmark: pgfId-1068687]Step 4 [bookmark: 59572]In the IP Address and Netmask fields, enter the IP address and network mask (in special notation, such as CIDR) that represent the hosts you want to target or exclude from targeting.
 
     [bookmark: pgfId-1068868]You should make sure that you specify a network that you configured the system to monitor in your network discovery policy. For information on using IP address notation in the FireSIGHT System, see IP Address Conventions.
 
      
       
     
 
     
 
     [bookmark: pgfId-1068701]Tip To target the entire monitored network, use 0.0.0.0/0 and ::/0.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1068588]Step 5 [bookmark: 94980]If you want to exclude the network from monitoring, select Exclude.
 
     [bookmark: pgfId-1068601]Step 6 To add additional networks, repeat steps 4 and 5.
 
     [bookmark: pgfId-1069796]Step 7 [bookmark: 60935]Target hosts that have a specific host attribute by clicking Add next to Targeted Host Attributes.
 
     [bookmark: pgfId-1069783]Step 8 [bookmark: 84359]From the Attribute and Value drop-down lists, specify the host attribute.
 
     [bookmark: pgfId-1069941]Step 9 To add additional host attributes, repeat steps 7 and 8.
 
     [bookmark: pgfId-1072975]A host must have at least one of the host attributes you specify to be evaluated against the white list.
 
     [bookmark: pgfId-1070470]Step 10 [bookmark: 59833]Target hosts that belong to a specific VLAN by clicking Add next to Targeted VLANs.
 
     [bookmark: pgfId-1070476]Step 11 [bookmark: 41634]In the VLAN ID field, specify the VLAN IDs of the hosts you want to evaluate against the white list. This can be any integer between 0 and 4095 for 802.1q VLANs.
 
     [bookmark: pgfId-1072939]Step 12 To add additional VLAN IDs, repeat steps 10 and 11.
 
     [bookmark: pgfId-1072973]The host must be a member of one of the VLANs you specify to be evaluated against the white list.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-1732267]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1065605][bookmark: 20744]Modifying Existing[bookmark: marker-1156383] Targets
 
    [bookmark: pgfId-1611759]License: FireSIGHT
 
    [bookmark: pgfId-1102003]After you modify a target, you must save the white list for your changes to take effect. Note that if you modify a target in a white list that is used by an active correlation policy, after you save the white list, any new target hosts are evaluated for compliance. However, this evaluation does not generate white list events. In addition, the system changes the white list host attribute of previously valid targets to Not Evaluated.
 
    [bookmark: pgfId-1101997]To modify an existing target:
 
    [bookmark: pgfId-1619204]Access: Admin 
 
    
 
    [bookmark: pgfId-1071514]Step 1 On the Create White List page, under Targets, click the target you want to modify.
 
    [bookmark: pgfId-1071530]The settings for the target appear.
 
    [bookmark: pgfId-1071534]Step 2 Make changes as needed.
 
    [bookmark: pgfId-1071539]You can rename the target, add or exclude additional networks, and add host attribute or VLAN restrictions. For more information, see Configuring Compliance White List Targets.
 
    [bookmark: pgfId-1732305]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1106101][bookmark: 33508]Deleting Existing[bookmark: marker-1156384] Targets
 
    [bookmark: pgfId-1611776]License: FireSIGHT
 
    [bookmark: pgfId-1106111]After you delete a target, you must save the white list for your changes to take effect. Note that if you delete a target from a white list that is used by an active correlation policy, the system changes the white list host attribute of previously valid targets to Not Evaluated.
 
    [bookmark: pgfId-1061774]To delete a white list target:
 
    [bookmark: pgfId-1619217]Access: Admin 
 
    
 ). 
    
 
    [bookmark: pgfId-1061954]Step 2 When prompted, confirm that you want to delete the target.
 
    [bookmark: pgfId-1061741]The target is deleted.
 
    [bookmark: pgfId-1732382]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1059727][bookmark: 22021]Configuring Compliance White List[bookmark: marker-1156385] Host Profiles
 
    [bookmark: pgfId-1611791]License: FireSIGHT
 
    [bookmark: pgfId-1106497]Host profiles in a compliance white list specify which operating systems, clients, application protocols, web applications, and protocols are allowed to run on the target hosts. There are three kinds of host profiles you can configure in a white list: 
 
     
     	 [bookmark: pgfId-1106548]global host profiles, which specify the application protocols, clients, web applications, and protocols that are allowed to run on target hosts, regardless of the host’s operating system
 
     	 [bookmark: pgfId-1106567]host profiles for specific operating systems, which specify not only which operating systems are allowed to run on your network, but also the application protocols, clients, web applications, and protocols that are allowed to run on those operating systems
 
     	 [bookmark: pgfId-1106572]shared host profiles, which function exactly like the host profiles for specific operating systems, except they are not tied to a single white list; you can use them across multiple white lists
 
    
 
    [bookmark: pgfId-1107112]For a more detailed introduction to compliance white list host profiles, see Understanding White List Host Profiles.
 
    [bookmark: pgfId-1117203]When you are finished creating compliance white list host profiles, you can add the white list to an active correlation policy to begin evaluating the target hosts for compliance, generating white list events when a host violated the white list, and optionally, triggering responses based on white list violations.
 
    [bookmark: pgfId-1107224]For information on how to create, modify, and delete compliance white list host profiles, see:
 
     
     	 [bookmark: pgfId-1108086]Configuring the Global Host Profile
 
     	 [bookmark: pgfId-1108042]Creating Host Profiles for Specific Operating Systems
 
     	 [bookmark: pgfId-1106224]Adding a Shared Host Profile to a Compliance White List
 
     	 [bookmark: pgfId-1108062]Modifying Existing Host Profiles
 
     	 [bookmark: pgfId-1106237]Deleting Existing Host Profiles
 
    
 
   
 
    
     [bookmark: pgfId-1108110][bookmark: 35088]Configuring the[bookmark: marker-1156386] Global Host Profile
 
    [bookmark: pgfId-1611807]License: FireSIGHT
 
    [bookmark: pgfId-1113190]Every white list contains a global host profile, which specifies the application protocols, clients, web applications, and protocols that are allowed to run on target hosts, regardless of the host’s operating system. For a more detailed introduction to the global host profile, see Understanding the Global Host Profile.
 
    [bookmark: pgfId-1723608]To configure the global host profile:
 
    [bookmark: pgfId-1723609]Access: Admin 
 
    
 
    [bookmark: pgfId-1723610]Step 1 On the Create White List page, under Allowed Host Profiles, click Any Operating System.
 
    [bookmark: pgfId-1113330]The settings for the global host profile appear.
 
    [bookmark: pgfId-1643490]Step 2 To specify the application protocols you want to allow, follow the directions in Adding an Application Protocol to a Host Profile.
 
    [bookmark: pgfId-1113202]Step 3 To specify the clients you want to allow, follow the directions in Adding a Client to a Host Profile.
 
    [bookmark: pgfId-1644562]Step 4 To specify the web applications you want to allow, follow the directions in Adding a Web Application to a Host Profile.
 
    [bookmark: pgfId-1113209]Step 5 To specify the protocols you want to allow, follow the directions in Adding a Protocol to a Host Profile. 
 
    [bookmark: pgfId-1113630]Note that ARP, IP, TCP, and UDP are always allowed.
 
    [bookmark: pgfId-1732398]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1108107][bookmark: 80313]Creating Host Profiles fo[bookmark: marker-1156391]r Specific Operating Systems
 
    [bookmark: pgfId-1611825]License: FireSIGHT
 
    [bookmark: pgfId-1113994]Host profiles for specific operating systems indicate not only which operating systems are allowed to run on your network, but also the application protocols, clients, web applications, and protocols that are allowed to run on those operating systems. For a more detailed introduction, see Understanding Host Profiles for Specific Operating Systems.
 
    [bookmark: pgfId-1065990]To create a new compliance white list host profile for a specific operating system:
 
    [bookmark: pgfId-1619246]Access: Admin 
 
    
 ). 
    
 
    [bookmark: pgfId-1066033]The settings for the new host profile appear.
 
    [bookmark: pgfId-1616420]Step 2 In the Name field, type a descriptive name for the host profile.
 
    [bookmark: pgfId-1075108]Step 3 From the OS Vendor, OS Name, and Version drop-down lists, pick the operating system and version for which you want to create a host profile.
 
    [bookmark: pgfId-1066116]Step 4 Specify the application protocols you want to allow. You have three options:
 
     
      
      	 [bookmark: pgfId-1066095]To allow all application protocols, leave the  Allow all Application Protocols check box selected.
 
      	 [bookmark: pgfId-1066128]To allow no application protocols, clear the  Allow all Application Protocols check box.
 
      	 [bookmark: pgfId-1066151]To allow specific application protocols, follow the directions in Adding an Application Protocol to a Host Profile.
 
     
 
    
 
    [bookmark: pgfId-1066201]Step 5 Specify the clients you want to allow. You have three options:
 
     
      
      	 [bookmark: pgfId-1613388]To allow all clients, leave the  Allow all Clients check box selected.
 
      	 [bookmark: pgfId-1613389]To allow no clients, clear the  Allow all Clients  check box.
 
      	 [bookmark: pgfId-1613392]To allow specific clients, follow the directions in Adding a Client to a Host Profile.
 
     
 
    
 
    [bookmark: pgfId-1644823]Step 6 Specify the web applications you want to allow. You have three options:
 
     
      
      	 [bookmark: pgfId-1644824]To allow all web applications, leave the  Allow all Web Applications check box selected.
 
      	 [bookmark: pgfId-1644825]To allow no web applications, clear the  Allow all Web Applications  check box.
 
      	 [bookmark: pgfId-1644828]To allow specific web applications, follow the directions in Adding a Web Application to a Host Profile.
 
     
 
    
 
    [bookmark: pgfId-1066348]Step 7 Specify the protocols you want to allow.
 
    [bookmark: pgfId-1066410]To add a protocol, next to Allowed Protocols, follow the directions in Adding a Protocol to a Host Profile. Note that ARP, IP, TCP, and UDP are always allowed.
 
    [bookmark: pgfId-1732481]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1723733][bookmark: 13935]Adding an Application Protocol to a[bookmark: marker-1723732] Host Profile
 
    [bookmark: pgfId-1723737]License: FireSIGHT
 
    [bookmark: pgfId-1723738]You can configure a compliance white list, using either a shared host profile or a host profile that belongs to a single white list, to allow certain application protocols to run on specific operating systems. You can also configure a white list to allow certain application protocols to run on any valid target; these are called globally allowed application protocols.
 
    [bookmark: pgfId-1616536]For any allowed application protocol, you can either specify the type of application protocol that you want to allow — FTP and SSH are examples of application protocol types — or you can allow a custom application protocol by specifying an application protocol type of any. You must also specify the protocol the allowed application protocol uses (TCP or UDP). You can allow the application protocol on any port, or restrict it to a port that you specify.
 
    [bookmark: pgfId-1096706]Optionally, you can require that the application protocol server have a specific vendor or version. For example, you could allow SSH to run on Linux hosts on port 22. You could also restrict the particular vendor and version to OpenSSH 4.2.
 
    [bookmark: pgfId-1096701]To add an application protocol to a compliance white list host profile:
 
    [bookmark: pgfId-1619261]Access: Admin 
 
    
 if you are modifying the Any Operating System host profile). 
    
 
    [bookmark: pgfId-1066609]A pop-up window appears. The application protocols listed are:
 
     
      
      	 [bookmark: pgfId-1227253]application protocols that you created within the white list
 
      	 [bookmark: pgfId-1227289]application protocols that existed in the network map when you surveyed your networks as described in Surveying Your Network
 
      	 [bookmark: pgfId-1227294]application protocols that are used by other host profiles in the white list, which may include built-in application protocols created by the VRT for use in the default white list
 
     
 
    
 
    [bookmark: pgfId-1616852]Step 2 You have two options:
 
     
      
      	 [bookmark: pgfId-1097188]To add an application protocol already in the list, select it and click  OK . Use Ctrl or Shift while clicking to select multiple application protocols. You can also click and drag to select multiple adjacent application protocols.
 
     
 
    
 
    [bookmark: pgfId-1066825]The application protocol is added. Note that if you added a built-in application protocol, its name appears in italics. You can skip the rest of the procedure, or optionally, to change any of the application protocol’s values (such as the port or protocol), click the application protocol you just added to display the application protocol editor.
 
     
      
      	 [bookmark: pgfId-1066676]To add a new application protocol, select  <New Application Protocol> and click  OK .
 
     
 
    
 
    [bookmark: pgfId-1068033]The application protocol editor appears.
 
    [bookmark: pgfId-1073123]Step 3 From the Type drop-down list, select the application protocol type. For custom application protocols, select any.
 
    [bookmark: pgfId-1073124]Step 4 Specify the application protocol port. You have two options:
 
     
      
      	 [bookmark: pgfId-1073125]To allow the application protocol to run on any port, check the  Any port check box.
 
      	 [bookmark: pgfId-1073126]To allow the application protocol to run only on a specific port, type the port number in the  port field.
 
     
 
    
 
    [bookmark: pgfId-1073127]Step 5 From the Protocol drop-down list, select the protocol: TCP or UDP.
 
    [bookmark: pgfId-1073128]Step 6 Optionally, in the Vendor and Version fields, specify a vendor and version for the application protocol.
 
    [bookmark: pgfId-1073129]If you do not specify a vendor or version, the white list allows all vendors and versions as long as the type and protocol match. Note that if you restrict the vendor and version, you must make sure to specify them exactly as they would appear in an event view or in the application protocols network map.
 
    [bookmark: pgfId-1097542]Step 7 Click OK.
 
    [bookmark: pgfId-1097856]The application protocol is added. Note that you must save the white list for your changes to take effect.
 
    [bookmark: pgfId-1097543]If you added an application protocol to a white list that is used by an active correlation policy, after you save the white list, the target hosts are re-evaluated. Although this re-evaluation may bring some hosts into compliance, it does not generate any white list events.
 
    [bookmark: pgfId-1732497]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1072154][bookmark: 67687]Adding a Client to a[bookmark: marker-1156389] Host Profile
 
    [bookmark: pgfId-1611871]License: FireSIGHT
 
    [bookmark: pgfId-1622620]You can configure a compliance white list, using either a shared host profile or a host profile that belongs to a single white list, to allow certain client applications to run on specific operating systems. You can also configure a white list to allow certain clients to run on any valid target; these are called globally allowed clients.
 
    [bookmark: pgfId-1622621]Optionally, you can require that the client be a specific version. For example, you could allow only Microsoft Internet Explorer 8.0 to run on Microsoft Windows hosts.
 
    [bookmark: pgfId-1073556]To add a client to a compliance white list host profile:
 
    [bookmark: pgfId-1619288]Access: Admin 
 
    
 if you are modifying the Any Operating System host profile). 
    
 
    [bookmark: pgfId-1073558]A pop-up window appears. The clients listed are:
 
     
      
      	 [bookmark: pgfId-1227402]clients that you created within the white list 
 
      	 [bookmark: pgfId-1227403]clients that were running on hosts in the network map when you surveyed your networks as described in Surveying Your Network
 
      	 [bookmark: pgfId-1249758]clients that are used by other host profiles in the white list, which may include built-in clients created by the VRT for use in the default white list
 
     
 
    
 
    [bookmark: pgfId-1073564]Step 2 You have two options:
 
     
      
      	 [bookmark: pgfId-1073565]To add a client already in the list, select it and click  OK . Use Ctrl or Shift while clicking to select multiple clients. You can also click and drag to select multiple adjacent clients.
 
     
 
    
 
    [bookmark: pgfId-1073566]The client is added. Note that if you added a built-in client, its name appears in italics. You can skip the rest of the procedure, or optionally, to change any of the client’s values (such as its version), click the client you just added to display the client editor.
 
     
      
      	 [bookmark: pgfId-1073567]To add a new client, select  <New Client> and click  OK .
 
     
 
    
 
    [bookmark: pgfId-1073568]The client editor appears.
 
    [bookmark: pgfId-1619976]Step 3 From the Client drop-down list, select the client.
 
    [bookmark: pgfId-1073578]Step 4 Optionally, in the Version field, specify a version for the client.
 
    [bookmark: pgfId-1073579]If you do not specify a version, the white list allows all versions as long as the name matches. Note that if you restrict the version, you must specify it exactly as it would appear in a table view of clients.
 
    [bookmark: pgfId-1073583]Step 5 Click OK.
 
    [bookmark: pgfId-1097846]The client is added. Note that you must save the white list for your changes to take effect.
 
    [bookmark: pgfId-1643736]If you added a client to a white list that is used by an active correlation policy, after you save the white list, the target hosts are re-evaluated. Although this re-evaluation may bring some hosts into compliance, it does not generate any white list events.
 
    [bookmark: pgfId-1732513]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1643748][bookmark: 47954]Adding a Web Application to a[bookmark: marker-1643747] Host Profile
 
    [bookmark: pgfId-1643752]License: FireSIGHT
 
    [bookmark: pgfId-1643753]You can configure a compliance white list, using either a shared host profile or a host profile that belongs to a single white list, to allow certain web applications to run on specific operating systems. You can also configure a white list to allow certain web applications to run on any valid target; these are called globally allowed web applications.
 
    [bookmark: pgfId-1643755]To add a web application to a compliance white list host profile:
 
    [bookmark: pgfId-1643756]Access: Admin 
 
    
 if you are modifying the Any Operating System host profile). 
    
 
    [bookmark: pgfId-1643761]A pop-up window appears, listing all web applications detected by the system. 
 
    [bookmark: pgfId-1643773]Step 2 Select a web application and click OK. Use Ctrl or Shift while clicking to select multiple web applications. You can also click and drag to select multiple adjacent web applications.
 
    [bookmark: pgfId-1643787]The web application is added. Note that you must save the white list for your changes to take effect.
 
    [bookmark: pgfId-1643788]If you added a web application to a white list that is used by an active correlation policy, after you save the white list, the target hosts are re-evaluated. Although this re-evaluation may bring some hosts into compliance, it does not generate any white list events.
 
    [bookmark: pgfId-1732535]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1643739][bookmark: 40032]Adding a Protocol to a[bookmark: marker-1643738] Host Profile
 
    [bookmark: pgfId-1611892]License: FireSIGHT
 
    [bookmark: pgfId-1097806]You can configure a compliance white list, using either a shared host profile or a host profile that belongs to a single white list, to allow certain protocols to run on specific operating systems. You can also configure a white list to allow certain protocols to run on any valid target; these are called globally allowed protocols. Note that ARP, IP, TCP, and UDP are always allowed to run on any host; you cannot disallow them.
 
    [bookmark: pgfId-1097807]For any allowed protocol, you must specify its type (Network or Transport) and number.
 
    [bookmark: pgfId-1073783]To add a protocol to a compliance white list host profile:
 
    [bookmark: pgfId-1619308]Access: Admin 
 
    
 if you are modifying the Any Operating System host profile). 
    
 
    [bookmark: pgfId-1227586]A pop-up window appears. The protocols listed are:
 
     
      
      	 [bookmark: pgfId-1227653]protocols that you created within the white list 
 
      	 [bookmark: pgfId-1227654]protocols that were running on hosts in the network map when you surveyed your networks as described in Surveying Your Network
 
      	 [bookmark: pgfId-1250022]protocols that are used by other host profiles in the white list, which may include built-in protocols created by the VRT for use in the default white list
 
     
 
    
 
    [bookmark: pgfId-1073791]Step 2 You have two options:
 
     
      
      	 [bookmark: pgfId-1073792]To add a protocol already in the list, select it and click  OK . Use Ctrl or Shift while clicking to select multiple protocols. You can also click and drag to select multiple adjacent protocols.
 
     
 
    
 
    [bookmark: pgfId-1073793]The protocol is added. Note that if you added a built-in protocol, its name appears in italics. You can skip the rest of the procedure, or optionally, to change any of the protocol’s values (such as the type or number) click the protocol you just added to display the protocol editor.
 
     
      
      	 [bookmark: pgfId-1073794]To add a new protocol, select  <New Protocol> and click  OK .
 
     
 
    
 
    [bookmark: pgfId-1073795]The protocol editor appears.
 
    [bookmark: pgfId-1073800]Step 3 From the Type drop-down list, select the protocol type: Network or Transport.
 
    [bookmark: pgfId-1073801]Step 4 Specify the protocol. You have two options:
 
     
      
      	 [bookmark: pgfId-1073802]Select a protocol from the drop-down list.
 
      	 [bookmark: pgfId-1073803]Select  Other (manual entry) to specify a protocol that is not in the list. For network protocols, type the appropriate number as listed in  http://www.iana.org/assignments/ethernet-numbers/ . For transport protocols, type the appropriate number as listed in  http://www.iana.org/assignments/protocol-numbers/ .
 
     
 
    
 
    [bookmark: pgfId-1074236]Step 5 Click OK.
 
    [bookmark: pgfId-1097629]The protocol is added. Note that you must save the white list for your changes to take effect.
 
    [bookmark: pgfId-1097836]If you added a protocol to a white list that is used by an active correlation policy, after you save the white list, the target hosts are re-evaluated. Although this re-evaluation may bring some hosts into compliance, it does not generate any white list events.
 
    [bookmark: pgfId-1732547]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1107580][bookmark: 60439]Adding a Shared Host Profile to[bookmark: marker-1156387] a Compliance White List
 
    [bookmark: pgfId-1611919]License: FireSIGHT
 
    [bookmark: pgfId-1107581]Shared host profiles are also tied to specific operating systems, but you can use them across white lists. That is, if you create multiple white lists but want to use the same host profile to evaluate hosts running a particular operating system across the white lists, use a shared host profile.
 
    [bookmark: pgfId-1107582]You can add any of the built-in shared host profiles to your compliance white lists, or you can add shared host profiles that you created. For more information, see Understanding Shared Host Profiles and Creating Shared Host Profiles.
 
    [bookmark: pgfId-1107589]To add a shared host profile to a compliance white list:
 
    [bookmark: pgfId-1619322]Access: Admin 
 
    
 
    [bookmark: pgfId-1107591]Step 1 [bookmark: 31079]On the Create White List page, click Add Shared Host Profile.
 
    [bookmark: pgfId-1107592]The Add Shared Host Profile page appears.
 
    [bookmark: pgfId-1107597]Step 2 From the Name drop-down list, select the shared host profile you want to add to your white list, and click OK.
 
    [bookmark: pgfId-1107598]The shared host profile is added to your white list and the Create White List page appears again. The shared host profile’s name appears in italics under Allowed Host Profiles.
 
     
      
    
 
    
 
    [bookmark: pgfId-1107899]Tip You can edit a shared host profile from within a white list that uses it by clicking on the profile name under Allowed Host Profiles. For more information, see Modifying Existing Host Profiles.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1732571]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1107902][bookmark: 33367]Modifying Existing Ho[bookmark: marker-1368454]st Profiles
 
    [bookmark: pgfId-1611951]License: FireSIGHT
 
    [bookmark: pgfId-1108451]After you modify a host profile within a compliance white list, you must save the white list for your changes to take effect. 
 
    [bookmark: pgfId-1109831]If a host profile you modify belongs to a white list used in an active correlation policy, modifying the profile may bring hosts into or out of compliance but does not generate white list events. Further, modifying a shared host profile affects every white list that uses it. This may bring hosts into or out of compliance not only in the white list you are working with, but in other white lists as well.
 
     
      
    
 
    
 
    [bookmark: pgfId-1223074]Tip As with other shared host profiles, you can edit the built-in host profiles used by the default white list. You can also reset them to their factory defaults. For more information, see Resetting Built-In Host Profiles to Their Factory Defaults.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1108414]To modify an existing host profile:
 
    [bookmark: pgfId-1619349]Access: Admin 
 
    
 
    [bookmark: pgfId-1114134]Step 1 On the Create White List page, click the name of the host profile you want to modify.
 ) also appears. 
    
 
    [bookmark: pgfId-1110333]Step 2 You have two options:
 
     
      
      	 [bookmark: pgfId-1110334]If you are modifying a shared host profile, click  Edit .
 
     
 
    
 
    [bookmark: pgfId-1108724]A pop-up window appears. Make changes as needed as described in the table below. Click Save All Profiles to save the profile, then click Done to close the pop-up window. 
 
    [bookmark: pgfId-1110556]For more information editing shared host profiles, see Modifying a Shared Host Profile.
 
     
      
      	 [bookmark: pgfId-1108552]If you are modifying either the white list’s global host profile or a host profile for a specific operating system, perform one of the actions described in the procedures below.
 
     
 
    
 
    [bookmark: pgfId-1732586]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659659]To rename the host profile:
 
    [bookmark: pgfId-1666576]Access: Admin
 
    
 
    [bookmark: pgfId-1659246]Step 1 Type a new name in the Name field.
 
    [bookmark: pgfId-1732623]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659248]To change the operating system for the host profile:
 
    [bookmark: pgfId-1666591]Access: Admin
 
    
 
    [bookmark: pgfId-1659250]Step 1 Select the new operating system and version from the OS Vendor, OS Name, and Version drop-down lists. 
 
    [bookmark: pgfId-1659698]If you change these values, you may also want to rename the host profile. Note that a white list’s global host profile has no operating system associated with it, so you cannot change it.
 
    [bookmark: pgfId-1732635]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659252]To add an application protocol:
 
    [bookmark: pgfId-1666606]Access: Admin
 
    
 
    [bookmark: pgfId-1659256]Step 1 Follow the directions in Adding an Application Protocol to a Host Profile.
 
    [bookmark: pgfId-1732687]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659259]To add a client:
 
    [bookmark: pgfId-1666621]Access: Admin
 
    
 
    [bookmark: pgfId-1659263]Step 1 Follow the directions in Adding a Client to a Host Profile.
 
    [bookmark: pgfId-1732699]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659266]To add a web application:
 
    [bookmark: pgfId-1666646]Access: Admin
 
    
 
    [bookmark: pgfId-1659270]Step 1 Follow the directions in Adding a Web Application to a Host Profile.
 
    [bookmark: pgfId-1732724]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659273]To add a protocol:
 
    [bookmark: pgfId-1666661]Access: Admin
 
    
 
    [bookmark: pgfId-1659277]Step 1 Follow the directions in Adding a Protocol to a Host Profile.
 
    [bookmark: pgfId-1732752]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659280]To allow all application protocols:
 
    [bookmark: pgfId-1666676]Access: Admin
 
    
 
    [bookmark: pgfId-1659282]Step 1 Under Allowed Application Protocols, select the Allow all Application Protocols check box. 
 
    [bookmark: pgfId-1659811]Note that the check box does not appear until you delete any application protocols you have previously allowed.
 
    [bookmark: pgfId-1732785]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659284]To allow all clients:
 
    [bookmark: pgfId-1666691]Access: Admin
 
    
 
    [bookmark: pgfId-1659286]Step 1 Under Allowed Clients, select the Allow all Clients check box. 
 
    [bookmark: pgfId-1659839]Note that the check box does not appear until you delete any clients you have previously allowed.
 
    [bookmark: pgfId-1732819]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659288]To allow all web applications:
 
    [bookmark: pgfId-1666707]Access: Admin
 
    
 
    [bookmark: pgfId-1659290]Step 1 Under Allowed Web Applications, select the Allow all Web Applications check box. 
 
    [bookmark: pgfId-1659865]Note that the check box does not appear until you delete any web applications you have previously allowed.
 
    [bookmark: pgfId-1732838]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659292]To modify an application protocol, client, web application, or protocol:
 
    [bookmark: pgfId-1666722]Access: Admin
 
    
 
    [bookmark: pgfId-1659294]Step 1 Click the element you want to modify. 
 
    [bookmark: pgfId-1659880]For more information on the properties you can change, see: 
 
     
      
      	 [bookmark: pgfId-1659297]Adding an Application Protocol to a Host Profile
 
      	 [bookmark: pgfId-1659301]Adding a Client to a Host Profile
 
      	 [bookmark: pgfId-1659305]Adding a Protocol to a Host Profile
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1659307]Note The changes you make to an application protocol, client, web application, or protocol are reflected in every host profile that uses that element.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1732924]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1659309]To delete an application protocol, client, web application, or protocol:
 
    [bookmark: pgfId-1666741]Access: Admin
 
    
 ). 
    
 
    [bookmark: pgfId-1659316]To survey your network:
 
    [bookmark: pgfId-1666803]Access: Admin
 
    
 
    [bookmark: pgfId-1659318]Step 1 Click Survey Network. Surveying your network can add additional allowed clients, application protocols, and protocols to the host profiles that already exist, and can create additional host profiles if the survey detects hosts running operating systems that were not detected during any initial survey. For more information, see Surveying Your Network.
 
     
      [bookmark: pgfId-1061980]
 
     [bookmark: pgfId-1732938]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1117530][bookmark: 48402]Deleting Existing Host[bookmark: marker-1156392] Profiles
 
    [bookmark: pgfId-1611986]License: FireSIGHT
 
    [bookmark: pgfId-1108317]After you delete a host profile from a compliance white list, you must save the white list for your changes to take effect. Note that deleting a shared host profile removes it from the white list, but does not delete the profile or remove it from any other white lists that use it. You cannot delete a white list’s global host profile.
 
    [bookmark: pgfId-1108152]If the host profile you delete belongs to one or more white lists used in an active correlation policy, deleting the profile may force hosts out of compliance, but does not generate white list events.
 
    [bookmark: pgfId-1073339]To delete a compliance white list host profile:
 
    [bookmark: pgfId-1619372]Access: Admin 
 
    
 ). 
    
 
    [bookmark: pgfId-1073344]Step 2 When prompted, confirm that you want to delete the host profile.
 
    [bookmark: pgfId-1062016]The host profile is deleted.
 
    [bookmark: pgfId-1732959]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1060191][bookmark: 59032]Managing Compliance[bookmark: marker-1156393] White Lists
 
    [bookmark: pgfId-1612194]License: FireSIGHT
 
    [bookmark: pgfId-1091964]Use the White List page to manage compliance white lists. You can create, modify, and delete white lists, including the default white list. You can also edit any shared host profiles you have created, as well as the built-in shared host profiles, and add new shared host profiles. For more information, see:
 
     
     	 [bookmark: pgfId-1092373]Creating Compliance White Lists
 
     	 [bookmark: pgfId-1091973]Modifying a Compliance White List
 
     	 [bookmark: pgfId-1091977]Deleting a Compliance White List
 
     	 [bookmark: pgfId-1114419]Working with Shared Host Profiles
 
    
 
     
      [bookmark: pgfId-1310338][bookmark: 64160]Modifying a Compliance[bookmark: marker-1310337] White List
 
     [bookmark: pgfId-1612225]License: FireSIGHT
 
     [bookmark: pgfId-1310388]When you modify a compliance white list that is included in an active correlation policy, the system re-evaluates the target hosts. Note that the system does not generate white list events — and therefore does not trigger any responses you associated with the white list — during this re-evaluation, even if the white list is included in an active correlation policy and a previously compliant host becomes non-compliant with the updated white list.
 
     [bookmark: pgfId-1092809]To modify an existing compliance white list:
 
     [bookmark: pgfId-1619415]Access: Admin 
 
     
 
     [bookmark: pgfId-1092552]Step 1 Select Policies > Correlation, then click White List.
 
     [bookmark: pgfId-1619040]The White List page appears.
 ). 
     
 
     [bookmark: pgfId-1619045]The Create White List page appears.
 
     [bookmark: pgfId-1092557]Step 3 Make modifications as necessary and click Save White List.
 
     [bookmark: pgfId-1092558]The white list is updated.
 
     [bookmark: pgfId-1732979]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1059394][bookmark: 49419]Deleting a[bookmark: marker-1156395] Compliance White List
 
     [bookmark: pgfId-1612248]License: FireSIGHT
 
     [bookmark: pgfId-1092670]You cannot delete a compliance white list that you are using in one or more correlation policies; you must first delete the white list from all policies where it is used. For information on deleting a white list from a policy, see Editing a Correlation Policy.
 
     [bookmark: pgfId-1092863]Deleting a white list also removes the host attribute associated with the white list from all hosts on your network.
 
     [bookmark: pgfId-1092674]To delete an existing compliance white list:
 
     [bookmark: pgfId-1619452]Access: Admin 
 
     
 
     [bookmark: pgfId-1092675]Step 1 Select Policies > Correlation, then click White List.
 
     [bookmark: pgfId-1092676]The White List page appears.
 ). 
     
 
     [bookmark: pgfId-1118136]The white list is deleted.
 
     [bookmark: pgfId-1732998]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1118139][bookmark: 77833]Working with Shared[bookmark: marker-1156398] Host Profiles
 
    [bookmark: pgfId-1612271]License: FireSIGHT
 
    [bookmark: pgfId-1310561]Shared host profiles specify which operating systems, clients, application protocols, web applications, and protocols are allowed to run on target hosts across multiple white lists. That is, if you create multiple white lists but want to use the same host profile to evaluate hosts running a particular operating system across the white lists, use a shared host profile. Note that the default white list uses a special category of shared host profiles, called built-in host profiles.
 
    [bookmark: pgfId-1223649]For a more detailed introduction to shared host profiles, see Understanding Shared Host Profiles.
 
    [bookmark: pgfId-1646611]You can create, modify, and delete shared host profiles. In addition, if you modify or delete any of the built-in shared host profiles, or modify or delete any of the built-in application protocols, protocols, or clients, you can reset them to their factory defaults. For more information, see:
 
     
     	 [bookmark: pgfId-1106762]Creating Shared Host Profiles
 
     	 [bookmark: pgfId-1106807]Modifying a Shared Host Profile
 
     	 [bookmark: pgfId-1106852]Deleting a Shared Host Profile
 
     	 [bookmark: pgfId-1224025]Resetting Built-In Host Profiles to Their Factory Defaults
 
    
 
    [bookmark: pgfId-1106741]After you create a shared host profile, you can add it to multiple white lists. For more information, see Adding a Shared Host Profile to a Compliance White List.
 
     
      [bookmark: pgfId-1060527][bookmark: 72759]Creating Shared[bookmark: marker-1156399] Host Profiles
 
     [bookmark: pgfId-1612301]License: FireSIGHT
 
     [bookmark: pgfId-1310625]Create a shared host profile if you want to use the same host profile to evaluate hosts running a particular operating system across multiple white lists.
 
      
       
     
 
     
 
     [bookmark: pgfId-1213961]Tip You can also create a shared host profile for your compliance white lists using the host profile of a specific host. For more information, see Creating a White List Host Profile from a Host Profile.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1114509]To create a shared host profile:
 
     [bookmark: pgfId-1619482]Access: Admin 
 
     
 
     [bookmark: pgfId-1074418]Step 1 Select Policies > Correlation, then click White List.
 
     [bookmark: pgfId-1074419]The White List page appears.
 
     [bookmark: pgfId-1060529]Step 2 Click Edit Shared Profiles.
 
     [bookmark: pgfId-1074578]The Edit Shared Profiles page appears.
 
     [bookmark: pgfId-1111844]Step 3 Optionally, survey your network.
 
     [bookmark: pgfId-1112266]Surveying your network creates several baseline shared white lists based on the data the system has accumulated about your network. This saves you from manually creating and configuring multiple shared host profiles. You have two options:
 
      
       
       	 [bookmark: pgfId-1112316]To survey your network, click  Survey Network . For more information, see Surveying Your Network.
 
      
 
     
 
     [bookmark: pgfId-1112355]The system creates one or more baseline shared host profiles. You can edit or delete these shared host profiles as described in Modifying a Shared Host Profile and Deleting a Shared Host Profile. To add any other shared host profiles you might need, continue with the next step.
 
      
       
       	 [bookmark: pgfId-1112317]To skip surveying your network, continue with the next step.
 
      
 
     
 ). 
     
 
     [bookmark: pgfId-1075041]The settings for the new shared host profile appear.
 
     [bookmark: pgfId-1617589]Step 5 In the Name field, type a descriptive name for the shared host profile.
 
     [bookmark: pgfId-1075120]Step 6 From the OS Vendor, OS Name, and Version drop-down lists, pick the operating system and version for which you want to create a shared host profile.
 
     [bookmark: pgfId-1075047]Step 7 Specify the application protocols you want to allow. You have three options:
 
      
       
       	 [bookmark: pgfId-1075048]To allow all application protocols, select the  Allow all Application Protocols check box.
 
       	 [bookmark: pgfId-1075049]To allow no application protocols, leave the  Allow all Application Protocols check box cleared.
 
       	 [bookmark: pgfId-1075050]To allow specific application protocols, next to  Allowed Application Protocols , follow the directions in Adding an Application Protocol to a Host Profile.
 
      
 
     
 
     [bookmark: pgfId-1075054]Step 8 Specify the clients you want to allow. You have three options:
 
      
       
       	 [bookmark: pgfId-1075055]To allow all clients, select the  Allow all Clients check box.
 
       	 [bookmark: pgfId-1075056]To allow no clients, leave the  Allow all Clients  check box cleared.
 
       	 [bookmark: pgfId-1075059]To allow specific clients, follow the directions in Adding a Client to a Host Profile.
 
      
 
     
 
     [bookmark: pgfId-1645354]Step 9 Specify the web applications you want to allow. You have three options:
 
      
       
       	 [bookmark: pgfId-1645355]To allow all web applications, select the  Allow all Web Applications check box.
 
       	 [bookmark: pgfId-1645248]To allow no web applications, leave the  Allow all Web Applications  check box cleared.
 
       	 [bookmark: pgfId-1645251]To allow specific web applications, follow the directions in Adding a Web Application to a Host Profile.
 
      
 
     
 
     [bookmark: pgfId-1075061]Step 10 Specify the protocols you want to allow.
 
     [bookmark: pgfId-1075064]To add a protocol, next to Allowed Protocols, follow the directions in Adding a Protocol to a Host Profile. Note that ARP, IP, TCP, and UDP are always allowed.
 
     [bookmark: pgfId-1111309]Step 11 Click Save all Profiles to save your changes.
 
     [bookmark: pgfId-1111310]The shared host profile is created. You can now add the shared host profile to any compliance white list.
 
     [bookmark: pgfId-1733013]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1106669][bookmark: 27324]Modifying a[bookmark: marker-1156400] Shared Host Profile
 
     [bookmark: pgfId-1612345]License: FireSIGHT
 
     [bookmark: pgfId-1109844]Modifying a shared host profile changes the profile for all the white lists it belongs to. For the white lists that use the shared host profile and are also used in an active correlation policy, modifying a shared host profile may bring hosts into or out of compliance, but does not generate white list events. 
 
      
      [bookmark: pgfId-1713905]To... 
     
 
      
      [bookmark: pgfId-1713907]You can... 
     
 
     [bookmark: pgfId-1713909]rename the host profile
 
     [bookmark: pgfId-1713911]type a new name in the Name field.
 
     [bookmark: pgfId-1713913]change the operating system
 
     [bookmark: pgfId-1713915]select the new operating system and version from the OS Vendor, OS Name, and Version drop-down lists. If you change these values, you may also want to rename the host profile.
 
     [bookmark: pgfId-1713917]add an application protocol
 
     [bookmark: pgfId-1713921]follow the directions in Adding an Application Protocol to a Host Profile.
 
     [bookmark: pgfId-1713924]add a client
 
     [bookmark: pgfId-1713928]follow the directions in Adding a Client to a Host Profile.
 
     [bookmark: pgfId-1713931]add a web application
 
     [bookmark: pgfId-1713935]follow the directions in Adding a Web Application to a Host Profile.
 
     [bookmark: pgfId-1713938]add a protocol
 
     [bookmark: pgfId-1713942]follow the directions in Adding a Protocol to a Host Profile.
 
     [bookmark: pgfId-1713945]allow all application protocols
 
     [bookmark: pgfId-1713947]under Allowed Application Protocols, select the Allow all Application Protocols check box. Note that the check box does not appear until you delete any application protocols you have previously allowed.
 
     [bookmark: pgfId-1713949]allow all clients
 
     [bookmark: pgfId-1713951]under Allowed Clients, select the Allow all Clients check box. Note that the check box does not appear until you delete any clients you have previously allowed.
 
     [bookmark: pgfId-1713953]allow all web applications
 
     [bookmark: pgfId-1713955]under Allowed Web Applications, select the Allow all Web Applications check box. Note that the check box does not appear until you delete any clients you have previously allowed.
 
     [bookmark: pgfId-1713957]modify an application protocol, client, web application, or protocol
 
     [bookmark: pgfId-1713959]click the element you want to modify. For more information on the properties you can change, see: 
 
      
      	 [bookmark: pgfId-1713962]Adding an Application Protocol to a Host Profile
 
      	 [bookmark: pgfId-1713966]Adding a Client to a Host Profile
 
      	 [bookmark: pgfId-1713970]Adding a Web Application to a Host Profile
 
      	 [bookmark: pgfId-1713974]Adding a Protocol to a Host Profile
 
     
 
     [bookmark: pgfId-1713976]Note The changes you make to an application protocol, client, or protocol are reflected in every host profile that uses that element. 
     
 
     [bookmark: pgfId-1713978]delete an application protocol, client, web application, or protocol 
 ). 
     
 
     [bookmark: pgfId-1713985]survey your network
 
     [bookmark: pgfId-1713987]click Survey Network. Surveying your network can add additional allowed clients, application protocols, web applications, and protocols to the host profiles that already exist, and can create additional host profiles if the survey detects hosts running operating systems that were not detected during any initial survey. For more information, see Surveying Your Network.
 
    
 
    [bookmark: pgfId-1110181]To modify a shared host profile:
 
    [bookmark: pgfId-1619509]Access: Admin 
 
    
 
    [bookmark: pgfId-1110182]Step 1 Select Policies > Correlation, then click White List.
 
    [bookmark: pgfId-1110183]The White List page appears.
 
    [bookmark: pgfId-1110184]Step 2 Click Edit Shared Profiles.
 
    [bookmark: pgfId-1110185]The Edit Shared Profiles page appears.
 
    [bookmark: pgfId-1110193]Step 3 Do you want to edit one of the built-in shared host profiles?
 
     
      
      	 [bookmark: pgfId-1225105]If yes, expand  Built-in Host Profiles to display those host profiles.
 
      	 [bookmark: pgfId-1225136]If no, continue with the next step.
 
     
 
    
 
    [bookmark: pgfId-1225096]Step 4 Click the name of the shared host profile you want to modify.
 
    [bookmark: pgfId-1110904]The host profile appears.
 
    [bookmark: pgfId-1617734]Step 5 Perform any of the actions described in Table 52-2.
 
    [bookmark: pgfId-1110195]Step 6 Click Save all Profiles to save your changes.
 
    [bookmark: pgfId-1110196]The shared host profile is saved.
 
    [bookmark: pgfId-1733025]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1106674][bookmark: 36986]Deleting a[bookmark: marker-1156401] Shared Host Profile
 
    [bookmark: pgfId-1612381]License: FireSIGHT
 
    [bookmark: pgfId-1109798]If the shared host profile you delete belongs to one or more white lists used in an active correlation policy, deleting the profile may force hosts out of compliance, but does not generate white list events.
 
     
      
    
 
    
 
    [bookmark: pgfId-1223479]Tip If you delete a built-in shared host profile that is used by the default white list, you can restore it by resetting the built-in profiles to their factory defaults. For more information, see Resetting Built-In Host Profiles to Their Factory Defaults.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1109732]To delete a shared host profile:
 
    [bookmark: pgfId-1619527]Access: Admin 
 
    
 
    [bookmark: pgfId-1109635]Step 1 Select Policies > Correlation, then click White List.
 
    [bookmark: pgfId-1109681]The White List page appears.
 
    [bookmark: pgfId-1109683]Step 2 Click Edit Shared Profiles.
 
    [bookmark: pgfId-1109642]The Edit Shared Profiles page appears.
 
    [bookmark: pgfId-1225259]Step 3 Do you want to delete one of the built-in shared host profiles?
 
     
      
      	 [bookmark: pgfId-1225260]If yes, expand  Built-in Host Profiles to display those host profiles.
 
      	 [bookmark: pgfId-1225288]If no, continue with the next step.
 
     
 
    
 ). 
    
 
    [bookmark: pgfId-1109771]Confirm that you want to delete the shared host profile.
 
    [bookmark: pgfId-1109762]Step 5 Click Save all Profiles to save your changes.
 
    [bookmark: pgfId-1142516]The shared host profile is deleted and removed from all compliance white lists that use it.
 
    [bookmark: pgfId-1733037]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1223096][bookmark: 52868]Resetting Built-In Host Profiles to Their Factory Defaults
 
    [bookmark: pgfId-1612406]License: FireSIGHT
 
    [bookmark: pgfId-1227848]The default white list uses a special category of shared host profiles, called built-in host profiles. Built-in host profiles use built-in application protocols, protocols, and clients. You can use any these elements as-is in both the default white list and in any custom white list that you create, or you can modify them to suit your needs. For more information, see Understanding Shared Host Profiles.
 
    [bookmark: pgfId-1225051]If you make changes to the built-in profiles, application protocols, protocols, web applications, or clients that you need to undo, you can reset to factory defaults. When you reset to factory defaults, the following things occur:
 
     
     	 [bookmark: pgfId-1225988] All built-in host profiles, application protocols, protocols, and clients that you modified are reset to their factory defaults.
 
     	 [bookmark: pgfId-1225989] All built-in host profiles, application protocols, protocols, and clients that you deleted are restored.
 
     	 [bookmark: pgfId-1225997] All white lists (including the default white list) that are used by active correlation policies and that used any of the reset built-in host profiles, application protocols, protocols, or clients are re-evaluated. Although this re-evaluation may change the compliance of some hosts into compliance, it does not generate any white list events.
 
    
 
    [bookmark: pgfId-1225326]To reset built-in host profiles, application protocols, protocols, and clients:
 
    [bookmark: pgfId-1619541]Access: Admin 
 
    
 
    [bookmark: pgfId-1225327]Step 1 Select Policies > Correlation, then click White List.
 
    [bookmark: pgfId-1225328]The White List page appears.
 
    [bookmark: pgfId-1225329]Step 2 Click Edit Shared Profiles.
 
    [bookmark: pgfId-1225330]The Edit Shared Profiles page appears.
 
    [bookmark: pgfId-1225332]Step 3 Click Built-in Host Profiles.
 
    [bookmark: pgfId-1225333]The Built-in Host Profiles page appears.
 
    [bookmark: pgfId-1617846]Step 4 Click Reset to Factory Defaults.
 
    [bookmark: pgfId-1225338]Step 5 Confirm that you want to reset to factory defaults by clicking OK. 
 
    [bookmark: pgfId-1226059]All built-in host profiles, application protocols, protocols, and clients are reset to factory defaults. Any white list that is used by an active correlation policy and that used any of the reset built-in host profiles, application protocols, protocols, or clients is re-evaluated.
 
    [bookmark: pgfId-1733064]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1724060][bookmark: 84076]Working with[bookmark: marker-1724059] White List Events
 
    [bookmark: pgfId-1724064]License: FireSIGHT
 
    [bookmark: pgfId-1724065]When the system generates a discovery event that indicates that a host is out of compliance with a white list that is included in an activated correlation policy, a white list event is generated. White list events are a special kind of correlation event, and are logged to the correlation event database. You can search, view, and delete white list events. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1062496]Tip For information on configuring the number of events saved in the database, see Configuring Database Event Limits. Note that white list events are stored in the correlation event database.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1062500]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1062504]Viewing White List Events
 
     	 [bookmark: pgfId-1062508]Understanding the White List Events Table
 
     	 [bookmark: pgfId-1062512]Searching for Compliance White List Events
 
    
 
     
      [bookmark: pgfId-1060266][bookmark: 28761]Viewing White List[bookmark: marker-1156405] Events
 
     [bookmark: pgfId-1612467]License: FireSIGHT
 
     [bookmark: pgfId-1062588]You can use the Defense Center to view a table of compliance white list events. Then, you can manipulate the event view depending on the information you are looking for.
 
     [bookmark: pgfId-1062589]The page you see when you access white list events differs depending on the workflow you use. You can use the predefined workflow, which includes the table view of white list events. You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
      
      [bookmark: pgfId-1534943]To... 
     
 
      
      [bookmark: pgfId-1534945]You can... 
     
 
     [bookmark: pgfId-1535015]view the host profile for a host
 ) that appears next to the IP address. 
     
 
     [bookmark: pgfId-1535022]view user profile information
 )that appears next to the user identity. For more information, see 
     Understanding User Details and Host History. 
     
 
     [bookmark: pgfId-1535032]sort and constrain events on the current workflow page
 
     [bookmark: pgfId-1535036]find more information in Sorting Drill-Down Workflow Pages.
 
     [bookmark: pgfId-1535039]navigate within the current workflow page
 
     [bookmark: pgfId-1535043]find more information in Navigating to Other Pages in the Workflow.
 
     [bookmark: pgfId-1535046]navigate between pages in the current workflow, keeping the current constraints
 
     [bookmark: pgfId-1535048]click the appropriate page link at the top left of the workflow page. For more information, see Using Workflow Pages.
 
     [bookmark: pgfId-1535053]learn more about the columns that appear
 
     [bookmark: pgfId-1535057]find more information in Understanding the White List Events Table.
 
     [bookmark: pgfId-1535060]modify the time and date range for displayed events
 
     [bookmark: pgfId-1535064]find more information in see Setting Event Time Constraints.
 
     [bookmark: pgfId-1535067]drill down to the next page in the workflow, constraining on a specific value
 
     [bookmark: pgfId-1535069]use one of the following methods:
 
      
      	 [bookmark: pgfId-1535070]on a drill-down page that you created in a custom workflow, click  a value within a row. Note that clicking a value within a row in a table view constrains the table view and does  not drill down to the next page.
 
      	 [bookmark: pgfId-1535071]To drill down to the next workflow page constraining on some users, select the check boxes next to the users you want to view on the next workflow page, then click  View .
 
      	 [bookmark: pgfId-1535072]To drill down to the next workflow page keeping the current constraints, click  View All .
 
     
 
     [bookmark: pgfId-1535073]Tip Table views always include “Table View” in the page name. 
    
 
    [bookmark: pgfId-1535077]For more information, see Constraining Events.
 
    [bookmark: pgfId-1535079]delete white list events from the system
 
    [bookmark: pgfId-1535081]use one of the following methods:
 
     
     	 [bookmark: pgfId-1535082]To delete some events, select the check boxes next to the events you want to delete, then click  Delete .
 
     	 [bookmark: pgfId-1535083]To delete all events in the current constrained view, click  Delete All , then confirm you want to delete all the events.
 
    
 
    [bookmark: pgfId-1535092]navigate to other event views to view associated events
 
    [bookmark: pgfId-1535096]find more information in Navigating Between Workflows.
 
   
 
   [bookmark: pgfId-1619650]To view compliance white list events:
 
   [bookmark: pgfId-1619651]Access: Admin/Any Security Analyst/Discovery Admin 
 
   
 
   [bookmark: pgfId-1619652]Step 1 Select Analysis > Correlation > White List Events.
 
   [bookmark: pgfId-1339813]The first page of the default white list events workflow appears. To use a different workflow, including a custom workflow, click (switch workflow).by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
   [bookmark: pgfId-1733076]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1060282][bookmark: 32681]Understanding the[bookmark: marker-1156407] White List Events Table
 
    [bookmark: pgfId-1612485]License: FireSIGHT
 
    [bookmark: pgfId-1062792]You can use the correlation policy feature to build correlation policies that let the system respond in real time to threats on your network. Correlation policies describe the type of activity that constitutes a policy violation, which include compliance white list violations. For more information on correlation policies, see Configuring Correlation Policies and Rules.
 
     
     [bookmark: pgfId-1062816]Field 
    
 
     
     [bookmark: pgfId-1062818]Description 
    
 
    [bookmark: pgfId-1062976]Time
 
    [bookmark: pgfId-1062978]The date and time that the white list event was generated.
 
    [bookmark: pgfId-1063006]IP Address
 
    [bookmark: pgfId-1063008]The IP address of the non-compliant host.
 
    [bookmark: pgfId-1237677]User
 
    [bookmark: pgfId-1237679]The identity of any known user logged in to the non-compliant host.
 
    [bookmark: pgfId-1063062]Port
 
    [bookmark: pgfId-1526733]The port, if any, associated with the event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol). For other types of white list violations, this field is blank.
 
    [bookmark: pgfId-1063086]Description
 
    [bookmark: pgfId-1063088]A description of how the white list was violated. For example:
 
    [bookmark: pgfId-1064295]Client “AOL Instant Messenger” is not allowed.
 
    [bookmark: pgfId-1064304]Violations that involve an application protocol indicate the application protocol name and version, as well as the port and protocol (TCP or UDP) it is using. If you restrict prohibitions to a particular operating system, the description includes the operating system name. For example:
 
    [bookmark: pgfId-1064328]Server "ssh / 22 TCP ( OpenSSH 3.6.1p2 )" is not
allowed on Operating System “Linux Linux 2.4 or
2.6”.
 
    [bookmark: pgfId-1063099]Policy
 
    [bookmark: pgfId-1063101]The name of the correlation policy that was violated, that is, the correlation policy that includes the white list.
 
    [bookmark: pgfId-1063111]White List
 
    [bookmark: pgfId-1063113]The name of the white list.
 
    [bookmark: pgfId-1063147]Priority
 
    [bookmark: pgfId-1063149]The priority specified by the policy or white list that triggered the policy violation. For information on setting correlation rule and policy priorities, see Providing Basic Policy Information and Setting Rule and White List Priorities.
 
    [bookmark: pgfId-1063159]Host Criticality
 
    [bookmark: pgfId-1063665]The user-assigned host criticality of the host that is out of compliance with the white list: None, Low, Medium, or High. For more information on host criticality, see Working with the Predefined Host Attributes.
 
    [bookmark: pgfId-1062837]Device
 
    [bookmark: pgfId-1062839]The name of the managed device that detected the white list violation.
 
    [bookmark: pgfId-1549480]Count
 
    [bookmark: pgfId-1549490]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
   
 
    
     [bookmark: pgfId-1118483][bookmark: 72194]Searching for[bookmark: marker-1156408] Compliance White List Events
 
    [bookmark: pgfId-1612508]License: FireSIGHT
 
    [bookmark: pgfId-1617978]You can search for specific compliance white list events. You may want to create searches customized for your network environment, then save them to re-use later. The following table describes the search criteria you can use.
 
     
      [bookmark: pgfId-1618052]
 
      
       
        
        [bookmark: pgfId-1617985]Table 52-5 [bookmark: 60415]Compliance White List Event Search Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-1617989]Field 
          
  
         	 
           
           [bookmark: pgfId-1617991]Search Criteria Rules 
          
  
        
 
         
         	[bookmark: pgfId-1617993]Policy
  
         	[bookmark: pgfId-1617995]Enter the name of a correlation policy to return all events caused by violations of white lists included in that policy.
  
        
 
         
         	[bookmark: pgfId-1617997]White List
  
         	[bookmark: pgfId-1617999]Enter the name of a white list to return all events caused by violations of that white list.
  
        
 
         
         	[bookmark: pgfId-1618001]Description
  
         	[bookmark: pgfId-1618003]Enter the white list event description.
  
        
 
         
         	[bookmark: pgfId-1618009]Priority
  
         	[bookmark: pgfId-1618011]Specify the priority of the white list event, which is determined either by the priority of the white list in a correlation policy or by the priority of the correlation policy itself. Note that the white list priority overrides the priority of its policy. Enter none for no priority.
 [bookmark: pgfId-1618012]For information on setting correlation rule and policy priorities, see Providing Basic Policy Information and Setting Rule and White List Priorities.
  
        
 
         
         	[bookmark: pgfId-1618020]IP Address
  
         	[bookmark: pgfId-1618022]Specify an IP address of a host that has become non-compliant with a white list.
  
        
 
         
         	[bookmark: pgfId-1618027]User
  
         	[bookmark: pgfId-1618029]Specify the identity of the user logged in to a host that has become non-compliant with a white list.
  
        
 
         
         	[bookmark: pgfId-1618031]Port
  
         	[bookmark: pgfId-1618033]Specify the port, if any, associated with the discovery event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol).
  
        
 
         
         	[bookmark: pgfId-1618038]Host Criticality
  
         	[bookmark: pgfId-1618040]Specify the host criticality of the source host involved in the white list event: None, Low, Medium, or High. For more information on host criticality, see Working with the Predefined Host Attributes.
  
        
 
         
         	[bookmark: pgfId-1618103]Device
  
         	[bookmark: pgfId-1755034]Type the device name or IP address, or a device group, stack, or cluster name to restrict the search to specific devices that detected the white list violation. For detailed information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1063373]To search for compliance white list events:
 
     [bookmark: pgfId-1619662]Access: Admin/Any Security Analyst 
 
     
 
     [bookmark: pgfId-1618149]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-1618150]The Search page appears.
 
     [bookmark: pgfId-1618151]Step 2 Select White List Events from the table drop-down list.
 
     [bookmark: pgfId-1618152]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-1628206]Step 3 Enter your search criteria in the appropriate fields, as described in Table 52-5, and keeping in mind the following additional points:
 
      
       
       	 [bookmark: pgfId-1628207]All fields accept negation ( ! ).
 
       	 [bookmark: pgfId-1750265]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
       	 [bookmark: pgfId-1750266]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
      
 
     
 
     [bookmark: pgfId-1750267] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-1750268] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-1750269] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
       
       	 [bookmark: pgfId-1750270]Searches return only records that match the search criteria specified for all fields.
 
       	 [bookmark: pgfId-1628209]Many fields accept one or more asterisks ( * ) as wild cards. 
 
       	 [bookmark: pgfId-1628210]Specify  n/a in any field to identify events where information is not available for that field; use  !n/a to identify the events where that field is populated.
 
       	 [bookmark: pgfId-1628214]Click the add object icon (
 
      
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-1628215]For more information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-1618198]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-1618222]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1618223]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-1746430]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-1746431]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-1746432]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-1746433]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-1750343]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-1750375]Your search results appear in the default white list events workflow, constrained by the current time range. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-1733092]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1201657][bookmark: 24070]Working with White List Vio[bookmark: marker-1279128]lations
 
    [bookmark: pgfId-1612534]License: FireSIGHT
 
    [bookmark: pgfId-1226402]The system keeps track of the ways in which hosts on your network violate the compliance white lists in active correlation policies. You can search and view these records. 
 
    [bookmark: pgfId-1208393]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1208397]Viewing White List Violations
 
     	 [bookmark: pgfId-1208401]Understanding the White List Violations Table
 
     	 [bookmark: pgfId-1208405]Searching for White List Violations
 
    
 
     
      [bookmark: pgfId-1201658][bookmark: 85353]Viewing White List Violations
 
     [bookmark: pgfId-1612549]License: FireSIGHT
 
     [bookmark: pgfId-1208523]You can use the Defense Center to view a table of white list violations. Then, you can manipulate the event view depending on the information you are looking for. The page you see when you access white list violations differs depending on the workflow you use. There are two predefined workflows:
 
      
      	 [bookmark: pgfId-1208749]The Host Violation Count workflow provides a series of pages that list all the hosts that violate at least one white list. The first page sorts the hosts based on the number of violations per host, with the hosts with the greatest number of violations at the top of the list. If a host violates more than one white list, there is a separate row for each violated white list. The workflow also contains a table view of white list violations that lists all violations with the most recently detected violation at the top of the list. Each row in the table contains a single detected violation. 
 
      	 [bookmark: pgfId-1691593]The White List Violations workflow includes a table view of white list violations that lists all violations with the most recently detected violation at the top of the list. Each row in the table contains a single detected violation.
 
     
 
     [bookmark: pgfId-1691594]Both predefined workflows terminate in a host view, which contains a host profile for every host that meets your constraints. You can also create a custom workflow that displays only the information that matches your specific needs. For more information, see Creating Custom Workflows.
 
      
      [bookmark: pgfId-1208542]To... 
     
 
      
      [bookmark: pgfId-1208544]You can... 
     
 
     [bookmark: pgfId-1208546]view the host profile for a host
 ) that appears next to the IP address. 
     
 
     [bookmark: pgfId-1208553]sort and constrain events on the current workflow page
 
     [bookmark: pgfId-1208557]find more information in Sorting Drill-Down Workflow Pages.
 
     [bookmark: pgfId-1208560]navigate within the current workflow page
 
     [bookmark: pgfId-1208564]find more information in Navigating to Other Pages in the Workflow.
 
     [bookmark: pgfId-1208567]navigate between pages in the current workflow, keeping the current constraints
 
     [bookmark: pgfId-1208569]click the appropriate page link at the top left of the workflow page. For more information, see Using Workflow Pages.
 
     [bookmark: pgfId-1208574]learn more about the columns that appear
 
     [bookmark: pgfId-1208578]find more information in Understanding the White List Violations Table.
 
     [bookmark: pgfId-1244316]drill down to the next page in the workflow
 
     [bookmark: pgfId-1244318]use one of the following methods:
 
      
      	 [bookmark: pgfId-1244319]To drill down to the next workflow page constraining on a specific value, click  a value within a row. Note that this only works on drill-down pages. Clicking a value within a row in a table view constrains the table view and does  not drill down to the next page.
 
      	 [bookmark: pgfId-1244320]To drill down to the next workflow page constraining on some events, select the check boxes next to the events you want to view on the next workflow page, then click  View .
 
      	 [bookmark: pgfId-1244321]To drill down to the next workflow page keeping the current constraints, click  View All .
 
     
 
     [bookmark: pgfId-1244322]Tip Table views always include “Table View” in the page name. 
    
 
    [bookmark: pgfId-1244325]For more information, see Constraining Events.
 
    [bookmark: pgfId-1208608]navigate to other event views to view associated events
 
    [bookmark: pgfId-1208613]find more information in Navigating Between Workflows.
 
   
 
   [bookmark: pgfId-1208650]To view compliance white list violations:
 
   [bookmark: pgfId-1619678]Access: Admin/Any Security Analyst/Discovery Admin
 
   
 
   [bookmark: pgfId-1208651]Step 1 Select Analysis > Correlation > White List Violations.
 
   [bookmark: pgfId-1339879]The first page of the default white list violations workflow appears. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings.
 
   [bookmark: pgfId-1733107]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1201627][bookmark: 90768]Understanding the White L[bookmark: marker-1368455]ist Violations Table
 
    [bookmark: pgfId-1612569]License: FireSIGHT
 
    [bookmark: pgfId-1211817]You can use the correlation policy feature to build correlation policies that let the system respond in real time to threats on your network. Correlation policies describe the type of activity that constitutes a policy violation, which include compliance white list violations. For more information on correlation policies, see Configuring Correlation Policies and Rules.
 
     
     [bookmark: pgfId-1211842]Field 
    
 
     
     [bookmark: pgfId-1211844]Description 
    
 
    [bookmark: pgfId-1211846]Time
 
    [bookmark: pgfId-1211848]The date and time that the white list violation was detected.
 
    [bookmark: pgfId-1211850]IP Address
 
    [bookmark: pgfId-1211852]The relevant IP address of the non-compliant host.
 
    [bookmark: pgfId-1211909]Type
 
    [bookmark: pgfId-1211911]The type of white list violation, that is, whether the violation occurred as a result of a non-compliant:
 
     
     	 [bookmark: pgfId-1211981]operating system ( os )
 
     	 [bookmark: pgfId-1211982]application protocol ( server )
 
     	 [bookmark: pgfId-1211983]client ( client  )
 
     	 [bookmark: pgfId-1211984]protocol ( protocol )
 
     	 [bookmark: pgfId-1660096]web application ( web )
 
    
 
    [bookmark: pgfId-1211926]Information
 
    [bookmark: pgfId-1211955]Any available vendor, product, or version information associated with the white list violation.
 
    [bookmark: pgfId-1212007]For example, if you have a white list that allows only Microsoft Windows hosts, the Information field describes the operating systems of the hosts that are not running Microsoft Windows.
 
    [bookmark: pgfId-1212043]For protocols that violate a white list, the Information field also indicates whether the violation is due to a network or transport protocol.
 
    [bookmark: pgfId-1211854]Port
 
    [bookmark: pgfId-1526852]The port, if any, associated with the event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol). For other types of white list violations, this field is blank.
 
    [bookmark: pgfId-1211933]Protocol
 
    [bookmark: pgfId-1526908]The protocol, if any, associated with the event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol). For other types of white list violations, this field is blank.
 
    [bookmark: pgfId-1211869]White List
 
    [bookmark: pgfId-1211871]The name of the white list that was violated.
 
    [bookmark: pgfId-1549526]Count
 
    [bookmark: pgfId-1549536]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
 
   
 
    
     [bookmark: pgfId-1251835][bookmark: 86557]Searching for White List Viol[bookmark: marker-1279129]ations
 
    [bookmark: pgfId-1612584]License: FireSIGHT
 
    [bookmark: pgfId-1212050]You can search for specific compliance white list violations. You may want to create searches customized for your network environment, then save them to re-use later. The following table describes the search criteria you can use.
 
     
      [bookmark: pgfId-1212129]
 
      
       
        
        [bookmark: pgfId-1212060]Table 52-8 [bookmark: 18660]Compliance White List Violations Search Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-1212064]Field 
          
  
         	 
           
           [bookmark: pgfId-1212066]Search Criteria Rules 
          
  
        
 
         
         	[bookmark: pgfId-1212068]Time
  
         	[bookmark: pgfId-1212070]Specify the date and time that the white list was violated.
  
        
 
         
         	[bookmark: pgfId-1212235]IP Address
  
         	[bookmark: pgfId-1212237]Specify an IP address of a host that has become non-compliant with a white list.
  
        
 
         
         	[bookmark: pgfId-1212072]White List
  
         	[bookmark: pgfId-1212074]Enter the name of a white list to return all violations from that white list.
  
        
 
         
         	[bookmark: pgfId-1212263]Type
  
         	[bookmark: pgfId-1212535]Enter the type of white list violation:
 
           
           	 [bookmark: pgfId-1212536]enter  os (or  operating system ) to search for violations based on operating systems
 
           	 [bookmark: pgfId-1212537]enter  server to search for violations based on application protocols
 
           	 [bookmark: pgfId-1243807]enter  client to search for violations based on clients
 
           	 [bookmark: pgfId-1212539]enter  protocol to search for violations based on protocols
 
           	 [bookmark: pgfId-1655753]enter  web application to search for violations based on web applications
 
          
  
        
 
         
         	[bookmark: pgfId-1212076]Information
  
         	[bookmark: pgfId-1212078]Enter white list violation information.
  
        
 
         
         	[bookmark: pgfId-1212102]Port
  
         	[bookmark: pgfId-1526959]Specify the port, if any, associated with the discovery event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol).
  
        
 
         
         	[bookmark: pgfId-1212112]Protocol
  
         	[bookmark: pgfId-1527015]Specify the protocol, if any, associated with the discovery event that triggered an application protocol white list violation (a violation that occurred as a result of a non-compliant application protocol).
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1212134]To search for compliance white list violations:
 
     [bookmark: pgfId-1312887]Access: Admin/Any Security Analyst 
 
     
 
     [bookmark: pgfId-1618409]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-1618410]The Search page appears.
 
     [bookmark: pgfId-1618411]Step 2 Select White List Violations from the table drop-down list.
 
     [bookmark: pgfId-1618412]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-1618428]Step 3 Enter your search criteria in the appropriate fields, as described in the Compliance White List Event Search Criteria table, and keeping in mind the following additional points:
 
      
       
       	 [bookmark: pgfId-1628121]All fields accept negation ( ! ).
 
       	 [bookmark: pgfId-1750944]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
       	 [bookmark: pgfId-1750940]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
      
 
     
 
     [bookmark: pgfId-1750497] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-1750498] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-1750499] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
       
       	 [bookmark: pgfId-1750500]Searches return only records that match the search criteria specified for all fields.
 
       	 [bookmark: pgfId-1628123]Many fields accept one or more asterisks ( * ) as wild cards. 
 
       	 [bookmark: pgfId-1628124]Specify  n/a in any field to identify events where information is not available for that field; use  !n/a to identify the events where that field is populated.
 
       	 [bookmark: pgfId-1628128]Click the add object icon (
 
      
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-1628129]For more information on search syntax, including using objects in searches, see Searching for Events.
 
     [bookmark: pgfId-1618436]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-1618437]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1212157]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-1750546]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-1750547]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-1750548]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-1750549]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-1212158]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-1340070]Your search results appear in the default white list violations workflow. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-1733122]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1201618]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2671859][bookmark: 87190]Creating Tra[bookmark: marker-2671857]ffic Pro[bookmark: marker-2671858]files 
      
      
 
     
 
 
    [bookmark: pgfId-3530607]A traffic profile is just that—a profile of the traffic on your network, based on connection data collected over a time span that you specify. You can use connection data collected by your devices, the connection data exported by any or all of your NetFlow-enabled devices, or both.
 
    [bookmark: pgfId-2671875]After you create a traffic profile, you can detect abnormal network traffic by evaluating new traffic against your profile, which presumably represents normal network traffic.
 
    [bookmark: pgfId-3546967]Keep in mind that the FireSIGHT System uses connection data to create traffic profiles and trigger correlation rules based on traffic profile changes. You cannot include connections that you do not log to the Defense Center database in traffic profiles. The system uses only end-of-connection data to populate connection summaries (see Understanding Connection Summaries), which the system then uses to create connection graphs and traffic profiles. Therefore, if you want to create and use traffic profiles, make sure you log connection events at the end of connections.
 
    [bookmark: pgfId-2671877]The time span used to collect data to build your traffic profile is called the [bookmark: marker-2671876]profiling time window (PTW). The PTW is a sliding window; that is, if your PTW is one week (the default), your traffic profile includes connection data collected over the last week. You can change the PTW to be as short as an hour or as long as several weeks.
 
    [bookmark: pgfId-2671878]When you first activate a traffic profile, it collects and evaluates connection data according to the criteria you have set, for a learning period equal in time to the PTW. The Defense Center does not evaluate rules you have written against the traffic profile until the learning period is complete.
 
    [bookmark: pgfId-2671882]You can create profiles using all the traffic on a monitored network segment, or you can create more targeted profiles using criteria based on the data in the connection events. For example, you could set the profile conditions so that the traffic profile only collects data where the detected session uses a specific port, protocol, or application. Or, you could add a host profile qualification to the traffic profile to collect data only for hosts that exhibit a host criticality of high.
 
    [bookmark: pgfId-2671883]Finally, when you create a traffic profile, you can specify inactive periods—periods in which connection data do not affect profile statistics and rules written against the profile do not trigger. You can also change how often the traffic profile aggregates and calculates statistics on collected connection data.
 
    [bookmark: pgfId-3607697]The following graphic shows a traffic profile with a PTW of one day and a sampling rate of five minutes.
 
    [bookmark: pgfId-3633520]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-2671893]After you create and activate a traffic profile and its learning period is complete, you can create correlation rules that trigger when you detect anomalous traffic. For example, you could write a rule that triggers if the amount of data traversing your network (measured in packets, KBytes, or number of connections) suddenly spikes to three standard deviations above the mean amount of traffic, which could indicate an attack or other security policy violation. Then, you could include that rule in a correlation policy to alert you of the traffic spike or to perform a remediation in response. For information on using traffic profiles to detect abnormal network traffic, see Creating Rules for Correlation Policies.
 
    [bookmark: pgfId-2671897]You create traffic profiles on the Traffic Profiles page. The slider icon next to each profile indicates whether the profile is active. If you want to base a correlation rule on a traffic profile change, you must activate the profile. If the slider icon is blue with a check mark, the profile is active. If it is gray with an x, the profile is inactive. For more information, see Activating and Deactivating Traffic Profiles.
 
    [bookmark: pgfId-2671910]The progress bar shows the status of the traffic profile’s learning period. When the progress bar reaches 100%, correlation rules written against the profile will trigger.
 
     
      
    
 
    
 
    [bookmark: pgfId-2671911]Tip You can sort traffic profiles by state (active versus inactive) or alphabetically by name using the Sort by drop-down list.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2671921]For more information, see:
 
     
     	 [bookmark: pgfId-2671925]Providing Basic Profile Information
 
     	 [bookmark: pgfId-2671929]Specifying Traffic Profile Conditions
 
     	 [bookmark: pgfId-2671933]Adding a Host Profile Qualification
 
     	 [bookmark: pgfId-2671937]Setting Profile Options
 
     	 [bookmark: pgfId-2671941]Saving a Traffic Profile
 
     	 [bookmark: pgfId-2671945]Activating and Deactivating Traffic Profiles
 
     	 [bookmark: pgfId-2671949]Editing a Traffic Profile
 
     	 [bookmark: pgfId-2671953]Understanding Condition-Building Mechanics
 
    
 
   
 
    
     [bookmark: pgfId-2671976][bookmark: 37564]Providing Basic Profile Information
 
    [bookmark: pgfId-3433080]License: FireSIGHT
 
    [bookmark: pgfId-2671978]When you create a traffic profile, you must give it a name and, optionally, a short description.
 
    [bookmark: pgfId-2671979]To begin creating a traffic profile:
 
    [bookmark: pgfId-2808684]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-2671980]Step 1 Select Policies > Correlation, then click Traffic Profiles.
 
    [bookmark: pgfId-2671981]The Traffic Profiles page appears.
 
    [bookmark: pgfId-2671986]Step 2 Click New Profile.
 
    [bookmark: pgfId-2671987]The Create Profile page appears.
 
    [bookmark: pgfId-2671992]Step 3 In the Profile Name field, type a name of up to 255 characters for the new traffic profile.
 
    [bookmark: pgfId-2671993]Step 4 In the Profile Description field, type a short description of up to 255 characters of the new traffic profile.
 
    [bookmark: pgfId-2671997]Step 5 Continue with Specifying Traffic Profile Conditions.
 
    [bookmark: pgfId-3611636]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2672033][bookmark: 56953]Specifying Traffic[bookmark: marker-2672031] Profile Cond[bookmark: marker-2672032]itions
 
    [bookmark: pgfId-3433120]License: FireSIGHT
 
    [bookmark: pgfId-2672034]Profile conditions constrain the kinds of connection data you want the traffic profile to track. A simple traffic profile that profiles all the traffic on a monitored network segment has no conditions. In contrast, traffic profiles can be complex, with multiple nested conditions.
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3558925]You build traffic profile conditions in the Profile Conditions section of the Create Profile page. See Understanding Condition-Building Mechanics for information on building conditions. Also, the syntax you can use to build conditions is fully described in Syntax for Traffic Profile Conditions.
 
     
      
    
 
    
 
    [bookmark: pgfId-3558932]Tip If you want to use the settings from an existing traffic profile, click Copy Settings and, in the pop-up window, select the traffic profile you want to use and click Load.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-2672087][bookmark: 58097]Syntax for Traffic Profile Conditions
 
     [bookmark: pgfId-3433152]License: FireSIGHT
 
     [bookmark: pgfId-2672091]The following table describes how to build a traffic profile condition.
 
     [bookmark: pgfId-2700918]Keep in mind that NetFlow records do not contain information about which host in the connection is the initiator and which is the responder. When the system processes NetFlow records, it uses an algorithm to determine this information based on the ports each host is using, and whether those ports are well-known. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     [bookmark: pgfId-3626151]The information available for a traffic profile depends on several factors, including the detection method, the logging method, and event type. For more information, see Information Available in Connection and Security Intelligence Events.
 
     [bookmark: pgfId-2700819]
 
      
       
        
        [bookmark: pgfId-2700777]Table 53-1 [bookmark: 75970]Syntax for Profile Conditions 
 
        
        
         
         	 
           
           [bookmark: pgfId-2700781]If you specify... 
          
  
         	 
           
           [bookmark: pgfId-2700783]Select an operator, then... 
          
  
        
 
         
         	[bookmark: pgfId-3595814]Ap[bookmark: marker-3595813]plication Protocol
  
         	[bookmark: pgfId-3595816]Select an application protocol name from the drop-down list of available protocols.
  
        
 
         
         	[bookmark: pgfId-3595837]Application Protocol Category
  
         	[bookmark: pgfId-3595839]Select an application protocol category name from the drop-down list of available categories.
  
        
 
         
         	[bookmark: pgfId-3595962]Cli[bookmark: marker-3595961]ent
  
         	[bookmark: pgfId-3595964]Select a client name from the drop-down list of available clients.
  
        
 
         
         	[bookmark: pgfId-3595966]Client Category
  
         	[bookmark: pgfId-3595968]Select a client category name from the drop-down list of available categories.
  
        
 
         
         	[bookmark: pgfId-3596068]Connection Type
  
         	[bookmark: pgfId-3596070]Specify in the traffic profile whether you want to use connection data collected by your Cisco devices or by NetFlow-enabled devices. If you do not specify a connection type, the traffic profile includes both.
  
        
 
         
         	[bookmark: pgfId-3596075]Destination Country or Source Country
  
         	[bookmark: pgfId-3596077]Select a country from the drop-down list of available countries. This represents the country associated with a source or destination IP address identified in network traffic.
  
        
 
         
         	[bookmark: pgfId-2700785]Initiator IP,
Responder IP, or Initiator/Responder IP
  
         	[bookmark: pgfId-2700787]Use a specific IP address or CIDR notation to specify a range of IP addresses. 
 [bookmark: pgfId-2700791]See Specifying IP Addresses in Searches for a description of the syntax allowed for IP addresses. Note, however, that you cannot use the local or remote keywords to specify IP addresses that are or are not in the networks you are monitoring.
  
        
 
         
         	[bookmark: pgfId-3596357]NetFlow Device
  
         	[bookmark: pgfId-3596359]Select the NetFlow-enabled device whose data you want to use to create the traffic profile. If you did not add any NetFlow-enabled devices to your deployment (using the local configuration), the NetFlow Device drop-down list is blank.
  
        
 
         
         	[bookmark: pgfId-2700793]Responder Port/ICMP Code
  
         	[bookmark: pgfId-2700795]Type the port number or ICMP code.
  
        
 
         
         	[bookmark: pgfId-3596361]Security Intelligence Category
  
         	[bookmark: pgfId-3596363]Select a Security Intelligence category name from the drop-down list of available categories. To use a Security Intelligence category for a traffic profile condition, that category must be set to Monitor instead of Block in the Security Intelligence section of your access control policy. For more information, see Building the Security Intelligence Whitelist and Blacklist.
  
        
 
         
         	[bookmark: pgfId-3596496]SSL Encrypted Session
  
         	[bookmark: pgfId-3596498]Select Successfully Decrypted.
  
        
 
         
         	[bookmark: pgfId-2700797]Transport Protocol
  
         	[bookmark: pgfId-2700799]Type TCP or UDP as the transport protocol.
  
        
 
         
         	[bookmark: pgfId-3558948]W[bookmark: marker-3566028]eb Application
  
         	[bookmark: pgfId-3558950]Select a web application name from the drop-down list of available web applications.
  
        
 
         
         	[bookmark: pgfId-3596524]Web Application Category
  
         	[bookmark: pgfId-3596526]Select a web application category name from the drop-down list of available categories.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2672144][bookmark: 51171]Adding a[bookmark: marker-2672143] Host Profile Qualification
 
    [bookmark: pgfId-3433180]License: FireSIGHT
 
    [bookmark: pgfId-2672145]You can constrain any traffic profile with information from the host profile of the tracked hosts. This constraint is called a host profile qualification. For example, as shown in the following graphic, you could collect connection data only for hosts that are assigned a host criticality of high.
 
    [bookmark: pgfId-3633568]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-2672154]To use a host profile qualification, the host must exist in the database and the host profile property you want to use as a qualification must already be included in the host profile. For example, if you configure a correlation policy rule to trigger when an intrusion event is generated on a host running Windows, the rule only triggers if the host is already identified as Windows when the intrusion event is generated.
 
    [bookmark: pgfId-2672155]To add a host profile qualification:
 
    [bookmark: pgfId-2808717]Access: Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-2672156]Step 1 On the Create Profile page, click Add Host Profile Qualification.
 
    [bookmark: pgfId-2672157]The Host Profile Qualification section appears.
 
    [bookmark: pgfId-2672162]Step 2 Build the host profile qualification’s conditions.
 
    [bookmark: pgfId-2672163]You can create a single, simple condition, or you can create more elaborate constructs by combining and nesting conditions. See Understanding Condition-Building Mechanics for information building conditions.
 
    [bookmark: pgfId-2672169]The syntax you can use to build conditions is described in Syntax for Host Profile Qualifications.
 
     
      
    
 
    
 
    [bookmark: pgfId-2672171]Tip To remove a host profile qualification, click Remove Host Profile Qualification.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-2672206][bookmark: 83498]Syntax fo[bookmark: marker-2672205]r Host Profile Qualifications
 
     [bookmark: pgfId-3433204]License: FireSIGHT
 
     [bookmark: pgfId-2672207]When you build a host profile qualification condition, you must first select the host you want to use to constrain your traffic profile. You can select either Responder Host or Initiator Host. After you select the host role, continue building your host profile qualification condition, as described in the Syntax for Host Profile Qualifications table.
 
     [bookmark: pgfId-2701551]Although you can configure the network discovery policy to add hosts to the network map based on data exported by NetFlow-enabled devices, the available information about these hosts is limited. For example, there is no operating system data available for these hosts, unless you provide it using the host input feature. In addition, if your traffic profile uses connection data exported by NetFlow-enabled devices, keep in mind that NetFlow records do not contain information about which host in the connection is the initiator and which is the responder. When the system processes NetFlow records, it uses an algorithm to determine this information based on the ports each host is using, and whether those ports are well-known. For more information, see Differences Between NetFlow and FireSIGHT Data.
 
     [bookmark: pgfId-3562713]To match against implied or generic clients, create a host profile qualification based on the application protocol used by the server responding to the client. When the client list on a host that acts as the initiator or source of a connection includes an application protocol name followed by client, that client may actually be an implied client. In other words, the system reports that client based on server response traffic that uses the application protocol for that client, not on detected client traffic. 
 
      
       
        
        [bookmark: pgfId-3559417]Table 53-2 [bookmark: 57817]Syntax for Host Profile Qualifications 
 
        
        
         
         	 
           
           [bookmark: pgfId-3559421]If you specify... 
          
  
         	 
           
           [bookmark: pgfId-3559423]Select an operator, then... 
          
  
        
 
         
         	[bookmark: pgfId-3559425]Host Type
  
         	[bookmark: pgfId-3559427]Select one or more host types from the drop-down list. You can choose between a normal host or one of several types of network device.
  
        
 
         
         	[bookmark: pgfId-3559429]NETBIOS Name
  
         	[bookmark: pgfId-3559431]Type the NetBIOS name of the host.
  
        
 
         
         	[bookmark: pgfId-3559433]Operating System > OS Vendor
  
         	[bookmark: pgfId-3559435]Select one or more operating system vendor names from the drop-down list.
  
        
 
         
         	[bookmark: pgfId-3559437]Operating System > OS Name
  
         	[bookmark: pgfId-3559439]Select one or more operating system names from the drop-down list.
  
        
 
         
         	[bookmark: pgfId-3559441]Operating System > OS Version
  
         	[bookmark: pgfId-3559443]Select one or more operating system versions from the drop-down list.
  
        
 
         
         	[bookmark: pgfId-3559445]Network Protocol
  
         	[bookmark: pgfId-3559448]Type the network protocol number as listed in http://www.iana.org/assignments/ethernet-numbers.
  
        
 
         
         	[bookmark: pgfId-3559450]Transport Protocol
  
         	[bookmark: pgfId-3559454]Type the name or number of the transport protocol as listed in http://www.iana.org/assignments/protocol-numbers.
  
        
 
         
         	[bookmark: pgfId-3559456]Host Criticality
  
         	[bookmark: pgfId-3559458]Select the host criticality from the list that appears. You can select None, Low, Medium, or High. For more information on host criticality, see Working with the Predefined Host Attributes.
  
        
 
         
         	[bookmark: pgfId-3559463]VLAN ID
  
         	[bookmark: pgfId-3559465]Type the VLAN ID number of the host.
  
        
 
         
         	[bookmark: pgfId-3559467]Application Protocol>
Application Protocol
  
         	[bookmark: pgfId-3559469]Select an application protocol from the drop-down list.
  
        
 
         
         	[bookmark: pgfId-3559471]Application Protocol >
Application Port
  
         	[bookmark: pgfId-3559474]Type the application protocol port number.
  
        
 
         
         	[bookmark: pgfId-3559476]Application Protocol >
Protocol
  
         	[bookmark: pgfId-3559478]Select the protocol from the drop-down list.
  
        
 
         
         	[bookmark: pgfId-3559480]Client > Client
  
         	[bookmark: pgfId-3559482]Select a client from the drop-down list.
  
        
 
         
         	[bookmark: pgfId-3559484]Client > Client Version 
  
         	[bookmark: pgfId-3559486]Type the client version.
  
        
 
         
         	[bookmark: pgfId-3559488]Web Application
  
         	[bookmark: pgfId-3559490]Select a client from the drop-down list.
  
        
 
         
         	[bookmark: pgfId-3559492]MAC Address > MAC Address
  
         	[bookmark: pgfId-3559494]Type all or part of the MAC address of the host.
  
        
 
         
         	[bookmark: pgfId-3559496]MAC Address > MAC Type
  
         	[bookmark: pgfId-3559498]Select whether the MAC type is ARP/DHCP Detected.
 [bookmark: pgfId-3559499]That is, select whether the system positively identified the MAC address as belonging to the host (is ARP/DHCP Detected), whether the system is seeing many hosts with that MAC address because, for example, there is a router between the device and the host (is not ARP/DHCP Detected), or whether the MAC type is irrelevant (is any).
  
        
 
         
         	[bookmark: pgfId-3559501]MAC Vendor
  
         	[bookmark: pgfId-3559503]Type all or part of the MAC vendor of hardware used by the host.
  
        
 
         
         	[bookmark: pgfId-3559505]any available host attribute, including the default compliance white list host attribute
  
         	[bookmark: pgfId-3559507]Specify the appropriate value, which depends on the type of host attribute you select:
 
           
           	 [bookmark: pgfId-3559508]If the host attribute type is Integer, enter an integer value in the range defined for the attribute. 
 
           	 [bookmark: pgfId-3559509]If the host attribute type is Text, and enter a text value.
 
           	 [bookmark: pgfId-3559510]If the host attribute type is List, select a valid list string from the drop-down list. 
 
           	 [bookmark: pgfId-3559511]If the host attribute type is URL, enter a URL value.
 
          
 [bookmark: pgfId-3559514]For more information on host attributes, see Working with User-Defined Host Attributes.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2672325][bookmark: 93939]Setting Profile Options
 
    [bookmark: pgfId-3433228]License: FireSIGHT
 
    [bookmark: pgfId-2672326]The [bookmark: marker-2901456]profiling time window (PTW) is the sliding time window, equal in length to the learning period, that the FireSIGHT System uses to calculate statistics for the traffic profile. The default PTW is one week, but you can change it to be as short as an hour or as long as several weeks.
 
    [bookmark: pgfId-2672330]Also, traffic profiles are based on aggregated connection data. By default, traffic profiles generate statistics on connection events generated by the system over five-minute intervals. However, you can set this sampling rate anywhere between the default five minutes and one hour.
 
    [bookmark: pgfId-2672334]Keep in mind that you should set your PTW and sampling rate so that your traffic profiles contain enough data to be statistically meaningful. For example, a PTW of one day with a sampling rate of one hour would only contain 24 data points, which may not be enough for accurate analysis of network traffic patterns.
 
     
      
    
 
    
 
    [bookmark: pgfId-2672335]Tip Your PTW should include at least 100 data points.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2672336]You can also set up inactive periods in traffic profile. For example, consider a network infrastructure where all the workstations are backed up at midnight every night. The backup takes about 30 minutes and spikes the network traffic. In that case, you might want to set up a recurring inactive period for your traffic profile to coincide with the scheduled backups. During inactive periods, the traffic profile collects data (so you can see the traffic on the traffic profile graphs), but that data is not used when calculating profile statistics. You can set up inactive periods to recur daily, weekly, or monthly. Inactive periods can be as short as five minutes or as long as one hour. Traffic profile graphs plotted over time show inactive periods as a shaded region.
 
    [bookmark: pgfId-2828589]To set profile options:
 
     
      
       
       [bookmark: pgfId-2672355]Table 53-3 [bookmark: 57545]Profile Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-2672359]If you want to... 
         
  
        	 
          
          [bookmark: pgfId-2672361]You can... 
         
  
       
 
        
        	[bookmark: pgfId-2672363]change the profiling time window
  
        	[bookmark: pgfId-2672365]in the Profiling Time Window field, type the number of hours, days, or weeks. Then choose hour(s), day(s), or week(s) from the drop-down list.
  
       
 
        
        	[bookmark: pgfId-2672367]change the sampling rate
  
        	[bookmark: pgfId-2672369]select the rate from the Sampling Rate drop-down list.
  
       
 
        
        	[bookmark: pgfId-2672371]add an inactive period
  
        	[bookmark: pgfId-2672373]click Add Inactive Period. Then, using the drop-down lists, specify when and how often you want the traffic profile to refrain from collecting data.
  
       
 
        
        	[bookmark: pgfId-2672375]delete an inactive period
  
        	[bookmark: pgfId-2672377]click Delete next to the inactive period you want to delete.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-2672413][bookmark: 56011]Saving a Traffic Pr[bookmark: marker-2672412]ofile
 
    [bookmark: pgfId-3433252]License: FireSIGHT
 
    [bookmark: pgfId-2672414]Use the following procedure to save a traffic profile.
 
    [bookmark: pgfId-2672415]To save a traffic profile:
 
    [bookmark: pgfId-2808728]Access: Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-2672416]Step 1 You have two options:
 
     
     	 [bookmark: pgfId-2672417]To save the profile without activating it, click  Save .
 
     	 [bookmark: pgfId-2672418]To save the profile and start collecting data immediately, click  Save & Activate .
 
    
 
    [bookmark: pgfId-3611763]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2672453][bookmark: 55368]Activating and Deacti[bookmark: marker-2672452]vating Traffic Profiles
 
    [bookmark: pgfId-3433276]License: FireSIGHT
 
    [bookmark: pgfId-2672454]When you want it to begin profiling the traffic on a monitored network segment, you must activate a traffic profile.
 
    [bookmark: pgfId-2672455]Deactivate a profile when you want it to stop collecting and evaluating connection data. Rules written against deactivated traffic profiles do not trigger. In addition, deactivating a traffic profile deletes all data collected and aggregated by the profile. If you later reactivate a deactivated traffic profile, you must wait the length of its PTW before rules written against it will trigger.
 
    [bookmark: pgfId-3538655]To activate or deactivate a traffic profile:
 
    [bookmark: pgfId-3539038]Access: Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-3539039]Step 1 Select Policies > Correlation, then click Traffic Profiles.
 
    [bookmark: pgfId-3539040]The Traffic Profiles page appears.
 
    [bookmark: pgfId-2672463]Step 2 You have two options:
 
     
      
      	 [bookmark: pgfId-2672464]To activate an inactive traffic profile, click  Activate next to the profile.
 
      	 [bookmark: pgfId-2672465]To deactivate an active traffic profile, click  Deactivate next to the profile. Confirm that you want to deactivate the profile by clicking  OK .
 
     
 
    
 
    [bookmark: pgfId-3611803]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2672500][bookmark: 39249]Editing a Traffic Pro[bookmark: marker-2672499]file
 
    [bookmark: pgfId-3433300]License: FireSIGHT
 
    [bookmark: pgfId-2672501]You cannot substantially edit an active traffic profile; if the traffic profile is active you can only change its name and description. To edit a traffic profile’s conditions options, you must first deactivate it. Note that deactivating a traffic profile deletes all the data it has collected.
 
    [bookmark: pgfId-2672504]For more information on activating and deactivating traffic profiles, see Activating and Deactivating Traffic Profiles.
 
    [bookmark: pgfId-2672506]To edit a traffic profile:
 
    [bookmark: pgfId-2808750]Access: Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-2672507]Step 1 Select Policies > Correlation, then click Traffic Profiles.
 
    [bookmark: pgfId-2672508]The Traffic Profiles page appears.
 
    [bookmark: pgfId-2672509]Step 2 Next to the traffic profile you want to edit, click Edit.
 
    [bookmark: pgfId-2672510]The Create Profile page appears.
 
    [bookmark: pgfId-2672511]Step 3 Make changes to the profile and click Save.
 
    [bookmark: pgfId-2672512]Your profile is updated.
 
    [bookmark: pgfId-3611817]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2672547][bookmark: 58151]Understanding Condition-Building[bookmark: marker-2672546] Mechanics
 
    [bookmark: pgfId-3433336]License: FireSIGHT
 
    [bookmark: pgfId-2672548]You build traffic profiles by specifying the conditions they use to collect data. You can create either simple conditions or more elaborate constructs with nested conditions.
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-2672576]The syntax you can use within conditions varies depending on the element you are creating, but the mechanics are the same. For more information, see:
 
     
     	 [bookmark: pgfId-2672580]Building a Single Condition
 
     	 [bookmark: pgfId-2672584]Adding and Linking Conditions
 
     	 [bookmark: pgfId-2672588]Using Multiple Values in a Condition
 
    
 
     
      [bookmark: pgfId-2672622][bookmark: 83231]Building a Single Condition
 
     [bookmark: pgfId-3433375]License: FireSIGHT
 
     [bookmark: pgfId-2672623]Most conditions have three parts: a category, an operator, and a value. Some conditions are more complex and contain several categories, each of which may have their own operators and values.
 
     [bookmark: pgfId-2672624]For example, the following traffic profile collects information on the 10.4.x.x network. The category of the condition is Initiator/Responder IP, the operator is is in, and the value is 10.4.0.0/16.
 
     [bookmark: pgfId-3633664]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-2672635]The following steps explain how to build this traffic profile condition.
 
     [bookmark: pgfId-3551239]To build a single condition:
 
     [bookmark: pgfId-2672636]Access: Admin/Discovery Admin 
 
     
 
     [bookmark: pgfId-2828594]Step 1 Select Policies > Correlation, then click Traffic Profiles.
 
     [bookmark: pgfId-2672637]The Traffic Profiles page appears.
 
     [bookmark: pgfId-2672638]Step 2 Click New Profile.
 
     [bookmark: pgfId-2672639]The Create Profile page appears.
 
     [bookmark: pgfId-2672640]Step 3 Under Profile Conditions, begin building the profile’s single condition by selecting Initiator/Responder IP from the first (category) drop-down list.
 
     [bookmark: pgfId-2672641]Step 4 Select is in from the second (operator) drop-down list.
 
      
       
     
 
     
 
     [bookmark: pgfId-2672642]Tip When the category represents an IP address, choosing is in or is not in as the operator allows you to specify whether the IP address is in or is not in a range of IP addresses, as expressed in CIDR notation. For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2672646]Step 5 Type 10.4.0.0/16 in the text field.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3612041]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3551283]The following steps explain how to build this host profile qualification.
 
     [bookmark: pgfId-3551337]To build this host profile qualification:
 
     [bookmark: pgfId-2828665]Access: Admin/Discovery Admin 
 
     
 
     [bookmark: pgfId-2672658]Step 1 Select Policies > Correlation, then click Traffic Profiles.
 
     [bookmark: pgfId-2672659]The Traffic Profiles page appears.
 
     [bookmark: pgfId-2672660]Step 2 Click New Profile.
 
     [bookmark: pgfId-2672661]The Create Profile page appears.
 
     [bookmark: pgfId-2672662]Step 3 Click Add Host Profile Qualification.
 
     [bookmark: pgfId-2672663]Step 4 Under Host Profile Qualification, in the first condition, specify the host whose information you want to collect.
 
     [bookmark: pgfId-2672664]In this example, select Responder Host because we only want information on responding hosts in a connection.
 
     [bookmark: pgfId-2672665]Step 5 Begin specifying the details of the operating system of the host by choosing the Operating System category.
 
     [bookmark: pgfId-2672666]Three subcategories appear: OS Vendor, OS Name, and OS Version. 
 
     [bookmark: pgfId-2672667]Step 6 To specify that the host can be running any version of Microsoft Windows, use the same operator for all three subcategories: is.
 
     [bookmark: pgfId-2672668]Step 7 Finally, specify the values for the subcategories.
 
     [bookmark: pgfId-2672669]Select Microsoft as the value for OS Vendor, Windows as the value for OS Name, and leave any as the value for OS Version.
 
     [bookmark: pgfId-2672670]Note that the categories you can choose from depend on whether you are building traffic profile conditions or a host profile qualification. In addition, a condition’s available operators depend on the category you choose. Finally, the syntax you can use to specify a condition’s value depends on the category and operator. Sometimes you must type the value in a text field. Other times, you can pick a value from a drop-down list.
 
      
       
     
 
     
 
     [bookmark: pgfId-2672671]Note Where the condition syntax allows you to pick a value from a drop-down list, you can often use multiple values from the list. For more information, see Using Multiple Values in a Condition.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2672675]For information on the syntax for building traffic profile conditions and host profile qualifications, see:
 
      
      	 [bookmark: pgfId-2672679]Syntax for Traffic Profile Conditions
 
      	 [bookmark: pgfId-2672683]Syntax for Host Profile Qualifications
 
     
 
     [bookmark: pgfId-3612034]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2672697][bookmark: 59566]Adding and Linking Conditions
 
     [bookmark: pgfId-3433403]License: FireSIGHT
 
     [bookmark: pgfId-2672698]You can create simple traffic profile conditions and host profile qualifications, or you can create more elaborate constructs by combining and nesting conditions.
 
     [bookmark: pgfId-2672699]When your construct includes more than one condition, you must link them with an AND or an OR operator. Conditions on the same level are evaluated together:
 
      
      	 [bookmark: pgfId-2672700]The  AND operator requires that all conditions on the level it controls must be met.
 
      	 [bookmark: pgfId-2672701]The  OR operator requires that at least one of the conditions on the level it controls must be met.
 
     
 
     [bookmark: pgfId-3542783]For example, the following traffic profile contains two conditions linked by AND. This means that the traffic profile collects connection data only if both conditions are true. In this example, it collects HTTP connections for all hosts with IP addresses in the 10.4.x.x subnet.
 
     [bookmark: pgfId-3633712]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
      
      [bookmark: pgfId-3552979]Where... 
     
 
      
      [bookmark: pgfId-3552981]Is the condition that states... 
     
 
     [bookmark: pgfId-3552983]A
 
     [bookmark: pgfId-3552985]Application Protocol Name is HTTP
 
     [bookmark: pgfId-3552987]B
 
     [bookmark: pgfId-3552989]IP Address is in 10.4.0.0/16
 
     [bookmark: pgfId-3552991]C
 
     [bookmark: pgfId-3552993]IP Address is in 192.168.0.0/16
 
    
 
    [bookmark: pgfId-3552946]To add a single condition:
 
    [bookmark: pgfId-3552779]Access: Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-2672743]Step 1 To add a single condition, click Add condition above the current condition.
 
    [bookmark: pgfId-3553771]A new condition is added to the same logical level as the current set of conditions. By default, it is linked to the conditions on its level with the OR operator, though you can change the operator to AND. 
 
    [bookmark: pgfId-3553772]For example, if you add a simple condition to the following host profile qualification:
 
    [bookmark: pgfId-3633760]
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3612159]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2672763]To add a complex condition:
 
    [bookmark: pgfId-2808800]Access: Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-2672764]Step 1 Click Add complex condition above the current condition.
 
    [bookmark: pgfId-2672765]A complex condition is added below the current set of conditions. The complex condition comprises two subconditions, which are linked to each other with the opposite operator from the one used to link the conditions on the level above it.
 
    [bookmark: pgfId-2672766]For example, if you add a complex condition to the following host profile qualification:
 
    [bookmark: pgfId-3633808]
 
     
     [image: ] 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-3612226]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2672784]To link conditions:
 
    [bookmark: pgfId-2808821]Access: Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-2672785]Step 1 Use the drop-down list to the left of a set of conditions:
 
     
     	 [bookmark: pgfId-2672786]To require that all conditions on the level that the operator controls are met, select  AND .
 
     	 [bookmark: pgfId-2672787]To require that only one of the conditions on the level that the operator controls is met, select  OR .
 
    
 
    [bookmark: pgfId-3612257]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2672801][bookmark: 86560]Using Multiple Values in a Condition
 
    [bookmark: pgfId-3433447]License: FireSIGHT
 
    [bookmark: pgfId-2672802]When you are building a condition, and the condition syntax allows you to pick a value from a drop-down list, you can often use multiple values from the list. For example, if you want to add a host profile qualification to a traffic profile that requires that a host be running some flavor of UNIX, instead of constructing multiple conditions linked with the OR operator, use the following procedure.
 
    [bookmark: pgfId-2672803]To include multiple values in one condition:
 
    [bookmark: pgfId-2808833]Access: Admin/Discovery Admin 
 
    
 
    [bookmark: pgfId-2672804]Step 1 Build a condition, choosing is in or is not in as the operator.
 
    [bookmark: pgfId-2672805]The drop-down list changes to a text field.
 
    [bookmark: pgfId-2672810]Step 2 Click anywhere in the text field or on the Edit link. 
 
    [bookmark: pgfId-2672811]A pop-up window appears.
 
    [bookmark: pgfId-2672816]Step 3 Under Available, use Ctrl or Shift while clicking to select multiple values. You can also click and drag to select multiple adjacent values.
 
    [bookmark: pgfId-2672817]Step 4 Click the right arrow (>) to move the selected entries to Selected.
 
    [bookmark: pgfId-2672818]Step 5 Click OK.
 
    [bookmark: pgfId-2672819]Your selections appear in the value field of your condition on the Create Profile page.
 
    [bookmark: pgfId-3612269]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2672838][bookmark: 23376]Viewing Traffic Pro[bookmark: marker-2672837]files
 
    [bookmark: pgfId-3433476]License: FireSIGHT
 
    [bookmark: pgfId-2672846]Because traffic profiles are based on connection data, you can view graphs of traffic profiles. The following graphic shows a traffic profile with a PTW of one week, a sampling rate of five minutes, and a daily half-hour inactive period from midnight to 12:30 AM.
 
    [bookmark: pgfId-3633856]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-2672855]You can perform almost all the same actions on traffic profile graphs that you can perform on connection data graphs. However, because traffic profiles are based on aggregated data (connection summaries), you cannot examine the individual connection events on which the graphs are based. In other words, you cannot drill down to a connection data table view from a traffic profile graph. See Viewing Connection and Security Intelligence Data for more information. In addition, traffic profiles appear as detached graphs. For more information, see Detaching Connection Graphs.
 
    [bookmark: pgfId-2672862]In addition, traffic profile graphs plotted over time show the mean (average) y-axis value as a bold horizontal line. Graphs over time also plot the values of the first four standard deviations above and below the mean, assuming that network traffic is distributed normally. By default, these statistics are calculated over the PTW, but if you alter the time settings for a graph, the Defense Center recalculates the statistics. Rules written against traffic profile statistics, however, are always evaluated against the statistics for the PTW.
 
    [bookmark: pgfId-2672866]To view a traffic profile graph for a traffic profile:
 
    [bookmark: pgfId-2808840]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-2672867]Step 1 Select Policies > Correlation, then click Traffic Profiles.
 
    [bookmark: pgfId-2672868]The Traffic Profiles page appears.
 ). 
    
 
    [bookmark: pgfId-2672874]The graph for the traffic profile appears in a separate browser window.
 
    [bookmark: pgfId-3612303]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2295243]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2996753][bookmark: 71635]Configuri[bookmark: marker-3009743]ng Remediations 
      
      
 
     
 
 
    [bookmark: pgfId-2996933]When a correlation policy violation occurs, you can configure the FireSIGHT System to initiate one or multiple responses, which include remediations (such as running an Nmap scan) and various types of alerts.
 
    [bookmark: pgfId-1886215]The most basic kind of response you can launch is an alert. Alerts notify you, via email, a SNMP trap server, or syslog, of a policy violation. For information on creating alerts, see Configuring External Alerting.
 
    [bookmark: pgfId-1886255]Another kind of response you can launch is a remediation. A remediation is a program that the Defense Center runs when your network traffic violates a correlation policy. The FireSIGHT System ships with predefined remediations, which perform actions such as blocking a host at the firewall or router when it violates a policy or scanning the host.
 
    [bookmark: pgfId-1789672]When the Defense Center launches a remediation, it generates a remediation status event. You can search, view, and delete remediation status events, as you would any other event.
 
    [bookmark: pgfId-1789668]The FireSIGHT System also provides a flexible API that allows you to create custom remediation modules to respond to correlation policy violations. For example, if you are running a Linux-based firewall, you could write and upload a remediation module that dynamically updates the iptables file on the Linux server so that traffic violating a correlation policy is blocked. For more information about writing your own remediation modules, refer to the Cisco Remediation API Guide.
 
     
      
    
 
    
 
    [bookmark: pgfId-3124814]Note You must use a Defense Center to configure and use remediations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1758219]For more information, see:
 
     
     	 [bookmark: pgfId-1754438]Creating Remediations
 
     	 [bookmark: pgfId-1754442]Working with Remediation Status Events
 
    
 
   
 
    
     [bookmark: pgfId-1755394][bookmark: 37207]Creating Re[bookmark: marker-1908760]mediations
 
    [bookmark: pgfId-2916306]License: FireSIGHT
 
    [bookmark: pgfId-1761305]In addition to alerts, which are simple notifications of a correlation policy violation, you can also configure responses called remediations. Remediations are programs that the Defense Center runs when a correlation policy is violated. These programs use information provided in the event that triggered the violation to perform a specific action.
 
    [bookmark: pgfId-1887966]The FireSIGHT System ships with several predefined remediation modules:
 
     
     	 [bookmark: pgfId-1761312]The Cisco IOS Null Route module, which, if you are running Cisco routers that use Cisco IOS Version 12.0 or higher, allows you to dynamically block traffic sent to an IP address or network that violates a correlation policy.
 
    
 
    [bookmark: pgfId-1761316]See Configuring Remediations for Cisco IOS Routers for more information.
 
     
     	 [bookmark: pgfId-1761317]The Cisco PIX Shun module, which, if you are running Cisco PIX Firewall Version 6.0 or higher, allows you to dynamically block traffic sent from an IP address that violates a correlation policy.
 
    
 
    [bookmark: pgfId-1761321]See Configuring Remediations for Cisco PIX Firewalls for more information.
 
     
     	 [bookmark: pgfId-2212736]The Nmap Scanning module, which allows you to actively scan specific targets to determine operating systems and servers running on those hosts. 
 
    
 
    [bookmark: pgfId-2212743]See Configuring Nmap Remediations for more information.
 
     
     	 [bookmark: pgfId-2263676]The Set Attribute Value module, which allows you to set a host attribute on a host where a correlation event occurs.
 
    
 
    [bookmark: pgfId-2263680]See Configuring Set Attribute Remediations.
 
    [bookmark: pgfId-1761335]You can create multiple instances for each remediation module, where each instance represents a connection to a specific appliance. For example, if you have four Cisco IOS routers where you want to send remediations, you should configure four instances of the Cisco IOS remediation module. 
 
    [bookmark: pgfId-1881372]When you create an instance, you specify the configuration information necessary for the Defense Center to establish a connection with the appliance. Then, for each configured instance, you add remediations that describe the actions you want the appliance to perform when a policy is violated.
 
    [bookmark: pgfId-1881381]After they are configured, you can add remediations to what are called response groups, or you can assign the remediations specifically to rules within correlation policies. When the system executes these remediations, it generates a remediation status event, which includes details such as the remediation name, the policy and rule that triggered it, and the exit status message. For more information on these events, see Working with Remediation Status Events.
 
    [bookmark: pgfId-1761345]In addition to the default modules that Cisco provides, you can write custom remediation modules that perform other specific tasks when policy violations trigger. Refer to the Remediation API Guide for more information about writing your own remediation modules and installing them on the Defense Center. If you are installing a[bookmark: marker-2093093] custom module, you can use the Modules page to install, view, and delete new modules.
 
    [bookmark: pgfId-3016431]To install a new module on the Defense Center:
 
    [bookmark: pgfId-3016457]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-3016433]Step 1 Select Policies > Actions > Modules.
 
    [bookmark: pgfId-3016217]The Modules page appears.
 
    [bookmark: pgfId-2852953]Step 2 Click Browse to navigate to the location where you saved the file that contains the custom remediation module (refer to the Remediation API Guide for more information).
 
    [bookmark: pgfId-1761362]Step 3 Click Install.
 
    [bookmark: pgfId-1761363]The custom remediation module installs.
 
    [bookmark: pgfId-3164919]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3016415]To view or delete a[bookmark: marker-3016411] module from the Defense Center:
 
    [bookmark: pgfId-3016478]Access: Admin/Discovery Admin
 
    
 
    [bookmark: pgfId-3016417]Step 1 Select Policies > Actions > Modules.
 
    [bookmark: pgfId-1761369]The Modules page appears.
 
    [bookmark: pgfId-1761370]Step 2 Perform one of the following actions:
 
     
      
      	 [bookmark: pgfId-1761371]Click  View to view the module. 
 
     
 
    
 
    [bookmark: pgfId-1761372]The Module Detail page appears.
 
     
      
      	 [bookmark: pgfId-1761373]Click  Delete next to the module you want to delete. You  cannot delete default modules provided by Cisco.
 
     
 
    
 
    [bookmark: pgfId-1761380]The remediation module is deleted.
 
    [bookmark: pgfId-3164976]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1763952][bookmark: 87871]Configuring Remediations for[bookmark: marker-2093101] Cisco IOS Routers
 
     [bookmark: pgfId-2916566]License: FireSIGHT
 
     [bookmark: pgfId-1763956]Cisco provides a Cisco IOS Null Route remediation module that allows you to block a single IP address or an entire block of addresses using Cisco’s “null route” command when a correlation policy is violated. This forwards all traffic sent to the host or network listed as the source or destination host in the event that violated the correlation policy to the router’s NULL interface, causing it to be dropped (note that this will not block traffic sent from the violating host or network).
 
     [bookmark: pgfId-1763957]The Cisco IOS Null Route remediation module supports Cisco routers running Cisco IOS 12.0 and higher. You must have level 15 administrative access to the router to execute Cisco IOS remediations.
 
      
       
     
 
     
 
     [bookmark: pgfId-1890705]Note A destination-based remediation only works if you configure it to launch when a correlation rule that is based on a connection event or intrusion event triggers. Discovery events only transmit source hosts.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1763958] 
      Caution When a Cisco IOS remediation is activated, there is no timeout period. To remove the blocked IP address or network from the router, you must manually clear the routing change from the router itself. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1763959]To create remediations for routers running Cisco IOS:
 
     [bookmark: pgfId-3016499]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1763960]Step 1 Enable Telnet on the Cisco router.
 
     [bookmark: pgfId-1763961]Refer to the documentation provided with your Cisco router or IOS software for more information about enabling Telnet.
 
     [bookmark: pgfId-1883576]Step 2 On the Defense Center, add a Cisco IOS Null Route instance for each Cisco IOS router you plan to use with the Defense Center.
 
     [bookmark: pgfId-1883583]See Adding a Cisco IOS Instance for the procedures.
 
     [bookmark: pgfId-1883584]Step 3 Create specific remediations for each instance, based on the type of response you want to elicit on the router when correlation policies are violated.
 
     [bookmark: pgfId-1763974]Each available remediation type is described in the following sections:
 
      
       
       	 [bookmark: pgfId-1763978]Cisco IOS Block Destination Remediations
 
       	 [bookmark: pgfId-1763982]Cisco IOS Block Destination Network Remediations
 
       	 [bookmark: pgfId-1763986]Cisco IOS Block Source Remediations
 
       	 [bookmark: pgfId-1763990]Cisco IOS Block Source Network Remediations
 
      
 
     
 
     [bookmark: pgfId-1763991]Step 4 Begin assigning Cisco IOS remediations to specific correlation policy rules.
 
     [bookmark: pgfId-3165035]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1763994][bookmark: 81061]Adding a[bookmark: marker-2093315] Cisco IOS Instance
 
     [bookmark: pgfId-2916591]License: FireSIGHT
 
     [bookmark: pgfId-1890630]After you configure Telnet access on the Cisco IOS router (refer to the documentation provided with your Cisco router or IOS software for more information about enabling Telnet access), you can add an instance to the Defense Center. If you have multiple routers where you want to send remediations, you must create a separate instance for each router.
 
     [bookmark: pgfId-1890644]To add a Cisco IOS instance:
 
     [bookmark: pgfId-3016512]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1890645]Step 1 Select Policies > Actions > Instances.
 
     [bookmark: pgfId-1764005]The Instances page appears.
 
     [bookmark: pgfId-1764006]Step 2 From the Add a New Instance list, select Cisco IOS Null Route (v1.0) and click Add.
 
     [bookmark: pgfId-1764007]The Edit Instance page appears.
 
     [bookmark: pgfId-1764008]Step 3 In the Instance Name field, enter a name for the instance.
 
     [bookmark: pgfId-1764009]The name you choose should contain no spaces or special characters and should be descriptive. For example, if you intend to connect more than one Cisco IOS router, you will have multiple instances, so you may want to choose a name such as IOS_01 and IOS_02.
 
     [bookmark: pgfId-1764010]Step 4 In the Router IP field, enter the IP address of the Cisco IOS router you want to use for the remediation.
 
     [bookmark: pgfId-1764011]Step 5 In the Username field, enter the Telnet user name for the router. This user must have level 15 administrative access on the router.
 
     [bookmark: pgfId-1764012]Step 6 In the Connection Password fields, enter the Telnet user’s user password. The password entered in both fields must match.
 
     [bookmark: pgfId-1764013]Step 7 In the Enable Password fields, enter the Telnet user’s enable password. This is the password used to enter privileged mode on the router. The password entered in both fields must match.
 
     [bookmark: pgfId-1764014]Step 8 In the White List field, enter IP addresses that you want to exempt from the remediation, one per line. You can also use CIDR notation or a specific IP address. For example, the following white list would be accepted by the system:
 
      
      [bookmark: pgfId-1764015]10.1.1.152 
     
 
      
      [bookmark: pgfId-1764017]172.16.1.0/24 
     
 
     [bookmark: pgfId-2031318]Note that this white list is not associated with any compliance white lists you have created. For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1764018]Step 9 Click Create.
 
     [bookmark: pgfId-1764019]The instance is created and remediations appear in the Configured Remediations section of the page. You must add specific remediations for them to be used by correlation policies. See the following sections for more information:
 
      
       
       	 [bookmark: pgfId-1764023]Cisco IOS Block Destination Remediations
 
       	 [bookmark: pgfId-1764027]Cisco IOS Block Destination Network Remediations
 
       	 [bookmark: pgfId-1764031]Cisco IOS Block Source Remediations
 
       	 [bookmark: pgfId-1764663]Cisco IOS Block Source Network Remediations
 
      
 
     
 
     [bookmark: pgfId-3165055]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1764673][bookmark: 82373]Cisco IOS[bookmark: marker-2093316] Block Destination Remediations
 
     [bookmark: pgfId-2916632]License: FireSIGHT
 
     [bookmark: pgfId-1764054]The Cisco IOS Block Destination remediation allows you to block traffic sent from the router to the destination host in a correlation event.
 
      
       
     
 
     
 
     [bookmark: pgfId-1890747]Note Do not use this remediation as a response to a correlation rule that is based on a discovery event; discovery events only transmit a source host and not a destination host. You can use this remediation in response to correlation rules that are based on connection events or intrusion events.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1764061]To add the remediation:
 
     [bookmark: pgfId-3016527]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1764062]Step 1 Select Policies > Actions > Instances.
 
     [bookmark: pgfId-1764063]The Instances page appears.
 ). 
     
 
     [bookmark: pgfId-1883596]If you have not yet added an instance, see Adding a Cisco IOS Instance.
 
     [bookmark: pgfId-1764068]The Edit Instance page appears.
 
     [bookmark: pgfId-1764069]Step 3 In the Configured Remediations section, select Block Destination and click Add.
 
     [bookmark: pgfId-1764070]The Edit Remediation page appears.
 
     [bookmark: pgfId-1764071]Step 4 In the Remediation Name field, enter a name for the remediation.
 
     [bookmark: pgfId-1764072]The name you choose cannot contain spaces or special characters and should be descriptive. For example, if you have multiple Cisco IOS router instances and multiple remediations for each instance, you may want to specify a name such as IOS_01_BlockDest.
 
     [bookmark: pgfId-1764073]Step 5 Optionally, in the Description field, enter a description of the remediation.
 
     [bookmark: pgfId-1884008]Step 6 Click Create, then click Done.
 
     [bookmark: pgfId-1764075]The remediation is added.
 
     [bookmark: pgfId-3165063]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1764079][bookmark: 26450]Cisco IOS[bookmark: marker-2093317] Block Destination Network Remediations
 
     [bookmark: pgfId-2916661]License: FireSIGHT
 
     [bookmark: pgfId-1764088]The Cisco IOS Block Destination Network remediation allows you to block any traffic sent from the router to the network of the destination host in a correlation event.
 
      
       
     
 
     
 
     [bookmark: pgfId-1890805]Note Do not use this remediation as a response to a correlation rule that is based on a discovery event; discovery events only transmit a source host and not a destination host. You can use this remediation in response to correlation rules that are based on connection events or intrusion events.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1764095]To add the remediation:
 
     [bookmark: pgfId-3016554]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1785950]Step 1 Select Policies > Actions > Instances.
 
     [bookmark: pgfId-1785951]The Instances page appears.
 
     [bookmark: pgfId-1764097]Step 2 Next to the instance where you want to add the remediation, click View.
 
     [bookmark: pgfId-1883606]If you have not yet added an instance, see Adding a Cisco IOS Instance.
 
     [bookmark: pgfId-1764101]The Edit Instance page appears.
 
     [bookmark: pgfId-1764102]Step 3 In the Configured Remediations section, select Block Destination Network and click Add.
 
     [bookmark: pgfId-1764103]The Edit Remediation page appears.
 
     [bookmark: pgfId-1764104]Step 4 In the Remediation Name field, enter a name for the remediation.
 
     [bookmark: pgfId-1764105]The name you choose cannot contain spaces or special characters and should be descriptive. For example, if you have multiple Cisco IOS router instances and multiple remediations for each instance, you may want to specify a name such as IOS_01_BlockDestNet.
 
     [bookmark: pgfId-1764106]Step 5 Optionally, in the Description field, enter a description of the remediation.
 
     [bookmark: pgfId-1764107]Step 6 In the Netmask field, enter the subnet mask or use CIDR notation to describe the network that you want to block traffic to.
 
     [bookmark: pgfId-1764108]For example, to block traffic to an entire Class C network when a single host triggered a rule (this is not recommended), use 255.255.255.0 or 24 as the netmask. 
 
     [bookmark: pgfId-1891243]As another example, to block traffic to 30 addresses that include the triggering IP address, specify 255.255.255.224 or 27 as the netmask. In this case, if the IP address 10.1.1.15 triggers the remediation, all IP addresses between 10.1.1.1 and 10.1.1.30 are blocked. To block only the triggering IP address, leave the field blank, enter 32, or enter 255.255.255.255.
 
     [bookmark: pgfId-1884039]Step 7 Click Create, then click Done.
 
     [bookmark: pgfId-1764110]The remediation is added.
 
     [bookmark: pgfId-3165107]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1764114][bookmark: 25142]Cisco IOS[bookmark: marker-2093318] Block Source Remediations
 
     [bookmark: pgfId-2916687]License: FireSIGHT
 
     [bookmark: pgfId-1891208]The Cisco IOS Block Source remediation allows you to block any traffic sent from the router to the source host included in a correlation event that violates a correlation policy. The source host is the source IP address in the connection event or intrusion event upon which the correlation rule is based, or the host IP address in a discovery event.
 
     [bookmark: pgfId-1764120]To add the remediation:
 
     [bookmark: pgfId-3016571]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1884485]Step 1 Select Policies > Actions > Instances.
 
     [bookmark: pgfId-1786250]The Instances page appears.
 
     [bookmark: pgfId-1764122]Step 2 Next to the instance where you want to add the remediation, click View. 
 
     [bookmark: pgfId-1883620]If you have not yet added an instance, see Adding a Cisco IOS Instance.
 
     [bookmark: pgfId-1766812]The Edit Instance page appears.
 
     [bookmark: pgfId-1766814]Step 3 In the Configured Remediations section, select Block Source and click Add.
 
     [bookmark: pgfId-1764128]The Edit Remediation page appears.
 
     [bookmark: pgfId-1764129]Step 4 In the Remediation Name field, enter a name for the remediation.
 
     [bookmark: pgfId-1764130]The name you choose cannot contain spaces or special characters and should be descriptive. For example, if you have multiple Cisco IOS router instances and multiple remediations for each instance, you may want to specify a name such as IOS_01_BlockSrc.
 
     [bookmark: pgfId-1764131]Step 5 Optionally, in the Description field, enter a description of the remediation.
 
     [bookmark: pgfId-1884066]Step 6 Click Create, then click Done.
 
     [bookmark: pgfId-1764133]The remediation is added.
 
     [bookmark: pgfId-3165113]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1764138][bookmark: 40242][bookmark: 32635]Cisco IOS[bookmark: marker-2093319] Block Source Network Remediations
 
     [bookmark: pgfId-2916707]License: FireSIGHT
 
     [bookmark: pgfId-1891265]The Cisco IOS Block Source Network remediation allows you to block any traffic sent from the router to the network of the source host in a correlation event. The source host is the source IP address in the connection event or intrusion event upon which the correlation rule is based, or the host IP address in a discovery event.
 
     [bookmark: pgfId-1764144]To add the remediation:
 
     [bookmark: pgfId-3016584]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1884492]Step 1 Select Policies > Actions > Instances.
 
     [bookmark: pgfId-1786268]The Instances page appears.
 
     [bookmark: pgfId-1764146]Step 2 Next to the instance where you want to add the remediation, click View. 
 
     [bookmark: pgfId-1883644]If you have not yet added an instance, see Adding a Cisco IOS Instance.
 
     [bookmark: pgfId-1764150]The Edit Instance page appears.
 
     [bookmark: pgfId-1764151]Step 3 In the Configured Remediations section, select Block Source Network and click Add.
 
     [bookmark: pgfId-1764152]The Edit Remediation page appears.
 
     [bookmark: pgfId-1764153]Step 4 In the Remediation Name field, enter a name for the remediation.
 
     [bookmark: pgfId-1764154]The name you choose should contain no spaces or special characters and should be descriptive. For example, if you have multiple Cisco IOS router instances and multiple remediations for each instance, you may want to specify a name such as IOS_01_BlockSourceNet.
 
     [bookmark: pgfId-1764155]Step 5 Optionally, in the Description field, enter a description of the remediation.
 
     [bookmark: pgfId-1764156]Step 6 In the Netmask field, enter the subnet mask or CIDR notation that describes the network that you want to block traffic to.
 
     [bookmark: pgfId-1764157]For example, to block traffic to an entire Class C network when a single host triggered a rule (this is not recommended), use 255.255.255.0 or 24 as the netmask. 
 
     [bookmark: pgfId-1891528]As another example, to block traffic to 30 addresses that include the triggering IP address, specify 255.255.255.224 or 27 as the netmask. In this case, if the IP address 10.1.1.15 triggers the remediation, all IP addresses between 10.1.1.1 and 10.1.1.30 are blocked. To block only the triggering IP address, leave the field blank, enter 32, or enter 255.255.255.255.
 
     [bookmark: pgfId-1884081]Step 7 Click Create, then click Done.
 
     [bookmark: pgfId-1764159]The remediation is added.
 
     [bookmark: pgfId-3165157]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1764236][bookmark: 82291]Configuring Remed[bookmark: marker-1764235]iations for Cisco PIX Firewalls
 
     [bookmark: pgfId-2916727]License: FireSIGHT
 
     [bookmark: pgfId-1764240]Cisco provides a Cisco PIX Shun remediation module that allows you to block an IP address or network using Cisco’s “shun” command. This blocks all traffic sent from either the source or destination host that violated the correlation policy and closes all current connections (note that this will not block traffic sent through the firewall to the host).
 
     [bookmark: pgfId-1764241]The Cisco PIX Shun remediation module supports Cisco PIX Firewall 6.0 and higher. You must have level 15 administrative access or higher to launch Cisco PIX remediations.
 
      
       
     
 
     
 
     [bookmark: pgfId-1891789]Note A destination-based remediation only works if you configure it to launch when a correlation rule that is based on a connection event or intrusion event triggers. Discovery events only transmit source hosts.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-1764242] 
      Caution When a Cisco PIX remediation is activated, no timeout period is used. To unblock the IP address or network, you must manually remove the rule from the firewall. 
       
       
 
      
 
     
 
     [bookmark: pgfId-1764243]To create remediations for Cisco PIX firewalls:
 
     [bookmark: pgfId-3016597]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1764244]Step 1 Enable Telnet or SSH (Cisco recommends SSH) on the firewall.
 
     [bookmark: pgfId-1764245]Refer to the documentation provided with your Cisco PIX firewall for more information about enabling SSH or Telnet.
 
     [bookmark: pgfId-1883657]Step 2 On the Defense Center, add a Cisco PIX Shun instance for each Cisco PIX firewall you plan to use with the Defense Center.
 
     [bookmark: pgfId-1883664]See Adding a Cisco PIX Instance for the procedures.
 
     [bookmark: pgfId-1883665]Step 3 Create specific remediations for each instance, based on the type of response you want to elicit on the firewall when correlation policies are violated.
 
     [bookmark: pgfId-1891905]The available remediation types are described in the following sections:
 
      
       
       	 [bookmark: pgfId-1764266]Cisco PIX Block Destination Remediations
 
       	 [bookmark: pgfId-1764270]Cisco PIX Block Source Remediations
 
      
 
     
 
     [bookmark: pgfId-1764271]Step 4 Begin assigning Cisco PIX remediations to specific correlation policy rules.
 
     [bookmark: pgfId-3165172]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1764274][bookmark: 81124]Adding a[bookmark: marker-2093320] Cisco PIX Instance
 
     [bookmark: pgfId-2916747]License: FireSIGHT
 
     [bookmark: pgfId-1764276]After you configure SSH or Telnet on the Cisco PIX firewall, you can add an instance to the Defense Center. If you have multiple firewalls you want to send remediations to, you must create a separate instance for each firewall.
 
      
       
     
 
     
 
     [bookmark: pgfId-1892462]Note Cisco recommends that you use an SSH connection instead of a Telnet connection. Data transmitted using SSH is encrypted, making it much more secure than Telnet.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1764284]To add a Cisco PIX instance:
 
     [bookmark: pgfId-3016612]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1764285]Step 1 Select Policies > Actions > Instances. 
 
     [bookmark: pgfId-1767195]The Instances page appears.
 
     [bookmark: pgfId-1767197]Step 2 From the Add a New Instance list, select Cisco PIX Shun and click Add.
 
     [bookmark: pgfId-1767333]The Edit Instance page appears.
 
     [bookmark: pgfId-1767336]Step 3 In the Instance Name field, type a name for the instance.
 
     [bookmark: pgfId-1767337]The name you choose cannot contain spaces or special characters and should be descriptive. For example, if you intend to connect more than one Cisco firewall, you will have multiple instances, so you may want to choose a name such as PIX_01, PIX_02, and so on.
 
     [bookmark: pgfId-3047521]Step 4 Optionally, type a description for the instance in the Description field.
 
     [bookmark: pgfId-1764291]Step 5 In the PIX IP field, enter the IP address of the Cisco PIX firewall you want to use for the remediation.
 
     [bookmark: pgfId-3047551]Step 6 If you require a specific username other than the default (pix), type it in the Username field.
 
     [bookmark: pgfId-1764292]Step 7 In the Connection Password fields, enter the password required to connect to the firewall using SSH or Telnet. The password entered in both fields must match.
 
     [bookmark: pgfId-1764293]Step 8 In the Enable Password fields, enter the SSH or Telnet enable password. This is the password used to enter privileged mode on the firewall. The password entered in both fields must match.
 
     [bookmark: pgfId-1764294]Step 9 In the White List field, enter IP addresses that you want to exempt from the remediation, one on each line. You can also use CIDR notation or a specific IP address. For example, the following white list is accepted by the system:
 
      
      [bookmark: pgfId-1764295]10.1.1.152 
     
 
      
      [bookmark: pgfId-1764297]172.16.1.0/24 
     
 
     [bookmark: pgfId-2031344]Note that this white list is not associated with any compliance white lists you have created. For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-1764298]Step 10 From the Protocol list, select the method you want to use to connect to the firewall.
 
     [bookmark: pgfId-1764301]Step 11 Click Create.
 
     [bookmark: pgfId-1764302]The instance is created and remediations appear in the Configured Remediations section of the page. You must add specific remediations for them to be used in correlation policies. See the following sections for more information:
 
      
       
       	 [bookmark: pgfId-1764309]Cisco PIX Block Destination Remediations
 
       	 [bookmark: pgfId-1764313]Cisco PIX Block Source Remediations
 
      
 
     
 
     [bookmark: pgfId-3165192]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1764323][bookmark: 22799]Cisco PIX[bookmark: marker-2093321] Block Destination Remediations
 
     [bookmark: pgfId-2916789]License: FireSIGHT
 
     [bookmark: pgfId-1764332]The Cisco PIX Block Destination remediation allows you to block traffic sent from the destination host in a correlation event.
 
      
       
     
 
     
 
     [bookmark: pgfId-1892523]Note Do not use this remediation as a response to a correlation rule that is based on a discovery event; discovery events only transmit a source host and not a destination host. You can use this remediation in response to correlation rules that are based on connection events or intrusion events.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1764339]To add the remediation:
 
     [bookmark: pgfId-3016627]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1884511]Step 1 Select Policies > Actions > Instances.
 
     [bookmark: pgfId-1786301]The Instances page appears.
 
     [bookmark: pgfId-1764341]Step 2 Next to the instance where you want to add the remediation, click View. 
 
     [bookmark: pgfId-1883675]If you have not yet added an instance, see Adding a Cisco PIX Instance.
 
     [bookmark: pgfId-1764345]The Edit Instance page appears.
 
     [bookmark: pgfId-1764346]Step 3 In the Configured Remediations section, select Block Destination and click Add.
 
     [bookmark: pgfId-1767944]The Edit Remediation page appears.
 
     [bookmark: pgfId-1767946]Step 4 In the Remediation Name field, enter a name for the remediation.
 
     [bookmark: pgfId-1891145]The name you choose cannot contain spaces or special characters and should be descriptive. For example, if you have multiple Cisco PIX firewall instances and multiple remediations for each instance, you may want to specify a name such as PIX_01_BlockDest.
 
     [bookmark: pgfId-1764350]Step 5 Optionally, in the Description field, enter a description of the remediation.
 
     [bookmark: pgfId-1884088]Step 6 Click Create, then click Done.
 
     [bookmark: pgfId-1764352]The remediation is added.
 
     [bookmark: pgfId-3165208]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1764356][bookmark: 83974]Cisco PIX[bookmark: marker-2093322] Block Source Remediations
 
     [bookmark: pgfId-2916821]License: FireSIGHT
 
     [bookmark: pgfId-1892742]The Cisco PIX Block Source remediation allows you to block any traffic sent from the source host included in the event that violates a correlation policy. The source host is the source IP address in the connection event or intrusion event upon which the correlation rule is based, or the host IP address in a discovery event.
 
     [bookmark: pgfId-1764362]To add the remediation:
 
     [bookmark: pgfId-3016659]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-1884594]Step 1 Select Policies > Actions > Instances.
 
     [bookmark: pgfId-1786403]The Instances page appears.
 
     [bookmark: pgfId-1764364]Step 2 Next to the instance where you want to add the remediation, click View.
 
     [bookmark: pgfId-1883687]If you have not yet added an instance, see Adding a Cisco PIX Instance.
 
     [bookmark: pgfId-1764368]The Edit Instance page appears.
 
     [bookmark: pgfId-1764369]Step 3 In the Configured Remediations section, select Block Source and click Add.
 
     [bookmark: pgfId-1764370]The Edit Remediation page appears.
 
     [bookmark: pgfId-1764371]Step 4 In the Remediation Name field, enter a name for the remediation.
 
     [bookmark: pgfId-1764372]The name you choose cannot contain spaces or special characters and should be descriptive. For example, if you have multiple Cisco PIX firewall instances and multiple remediations for each instance, you may want to specify a name such as PIX_01_BlockSrc.
 
     [bookmark: pgfId-1764373]Step 5 Optionally, in the Description field, enter a description of the remediation.
 
     [bookmark: pgfId-1764375]The remediation is added.
 
     [bookmark: pgfId-3165242]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2207731][bookmark: 25666]Configuring Nmap Remedi[bookmark: marker-2286289]ations
 
     [bookmark: pgfId-2916927]License: FireSIGHT
 
     [bookmark: pgfId-2244495]You can respond to a correlation event by scanning the host where the triggering event occurred. You can choose to scan only the port from the event that triggered the correlation event. 
 
     [bookmark: pgfId-2244515]To set up Nmap scanning in response to a correlation event, you must first create an Nmap scan instance, then add an Nmap scan remediation. You can then configure Nmap scanning as responses to violations of rules within the policy. 
 
     [bookmark: pgfId-2220001]See the following sections:
 
      
      	 [bookmark: pgfId-2220002]Adding an Nmap Scan Instance
 
      	 [bookmark: pgfId-2926944]Nmap Scan Remediations
 
     
 
    
 
     
      [bookmark: pgfId-2766406][bookmark: 14779]Adding an Nmap Scan Insta[bookmark: marker-2766405]nce
 
     [bookmark: pgfId-2916958]License: FireSIGHT
 
     [bookmark: pgfId-2207810]You can set up a separate scan instance for each Nmap module that you want to use to scan hosts on your network for operating system and server information. You can set up scan instances for the local Nmap module on your Defense Center and for any managed devices you want to use to run scans remotely. The results of each scan are always stored on the Defense Center where you configure the scan, even if you run the scan from a remote managed device. To prevent accidental or malicious scanning of mission-critical hosts, you can create a blacklist for the instance to indicate the hosts that should never be scanned with the instance.
 
     [bookmark: pgfId-2207817]Note that you cannot add a scan instance with the same name as any existing scan instance.
 
     [bookmark: pgfId-2207818]To create a scan instance:
 
     [bookmark: pgfId-3016677]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2209175]Step 1 Select Policies > Actions > Instances. 
 
     [bookmark: pgfId-2209176]The Instances page appears.
 
     [bookmark: pgfId-2209151]Step 2 Select Nmap Remediation (v1.0) from the Add a module type drop-down list and click Add.
 
     [bookmark: pgfId-2209152]The Edit Instance page appears.
 
     [bookmark: pgfId-2207831]Step 3 In the Instance Name field, enter a name that includes 1 to 63 alphanumeric characters, with no spaces and no special characters other than underscore (_) and dash (-). 
 
     [bookmark: pgfId-2207832]Step 4 In the Description field, specify a description that includes 0 to 255 alphanumeric characters, including spaces and special characters.
 
     [bookmark: pgfId-2207833]Step 5 Optionally, in the Black Listed Scan hosts field, specify any hosts or networks that should never be scanned with this scan instance, using the following syntax:
 
      
       
       	 [bookmark: pgfId-3124553]For IPv6 hosts, an exact IP address (for example,  2001:DB8::fedd:eeff )
 
       	 [bookmark: pgfId-3124555]For IPv4 hosts, an exact IP address (for example,  192.168.1.101 ) or an IP address block using CIDR notation (for example,  192.168.1.0/24 scans the 254 hosts between  192.168.1.1 and  192.168.1.254 , inclusive)
 
      
 
     
 
     [bookmark: pgfId-2207836]If you specifically target a scan to a host that is in a blacklisted network, that scan will not run. For information on using CIDR notation in the FireSIGHT System, see IP Address Conventions.
 
     [bookmark: pgfId-2207839]Step 6 Optionally, to run the scan from a remote managed device instead of the Defense Center, specify the name or IP address of the managed device in the Remote Device Name field.
 
     [bookmark: pgfId-2207841]Step 7 Click Create.
 
     [bookmark: pgfId-2207842]The scan instance is created. 
 
     [bookmark: pgfId-3165258]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2926996][bookmark: 34626]Nmap Scan Remed[bookmark: marker-2926995]iations
 
     [bookmark: pgfId-2927004]License: FireSIGHT
 
     [bookmark: pgfId-2927005]You can define the settings for an Nmap scan by creating an Nmap remediation. An Nmap remediation can be used as a response in a correlation policy, run on demand, or scheduled to run at a specific time. In order for the results of an Nmap scan to appear in the network map, the scanned host must already exist in the network map. Note that NetFlow, the host input feature, and the system itself can add hosts to the network map.
 
     [bookmark: pgfId-2927011]For more information on the specific settings in an Nmap remediation, see Understanding Nmap Remediations.
 
     [bookmark: pgfId-3015921]Note that Nmap-supplied server and operating system data remains static until you run another Nmap scan. If you plan to scan a host for operating system and server data using Nmap, you may want to set up regularly scheduled scans to keep any Nmap-supplied operating system and server data up-to-date. For more information, see Automating Nmap Scans. Also note that if the host is deleted from the network map, any Nmap scan results for that host are discarded.
 
     [bookmark: pgfId-2927018]For general information about Nmap functionality, refer to the Nmap documentation at http://insecure.org.
 
     [bookmark: pgfId-2927019]To create a Nmap remediation:
 
     [bookmark: pgfId-3016693]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2927021]Step 1 Select Policies > Actions > Scanners.
 
     [bookmark: pgfId-2927022]The Scanners page appears.
 
     [bookmark: pgfId-2927027]Step 2 Click Add Remediation next to the scan instance where you want to add a remediation.
 
     [bookmark: pgfId-2927028]The Edit Remediation page appears.
 
     [bookmark: pgfId-2927033]Step 3 In the Remediation Name field, type a name for the remediation that includes 1 to 63 alphanumeric characters, with no spaces and no special characters other than underscore (_) and dash (-).
 
     [bookmark: pgfId-2927034]Step 4 In the Description field, type a description for the remediation that includes 0 to 255 alphanumeric characters, including spaces and special characters.
 
     [bookmark: pgfId-2927035]Step 5 If you plan to use this remediation in response to a correlation rule that triggers on an intrusion event, a connection event, or a user event, configure the Scan Which Address(es) From Event? option.
 
      
       
       	 [bookmark: pgfId-2927039]Select  Scan Source and Destination Addresses to scan the hosts represented by the source IP address and the destination IP address in the event.
 
       	 [bookmark: pgfId-2927040]Select  Scan Source Address Only to scan the host represented by the event’s source IP address.
 
       	 [bookmark: pgfId-2927041]Select  Scan Destination Address Only to scan the host represented by the event’s destination IP address.
 
      
 
     
 
     [bookmark: pgfId-2927045]If you plan to use this remediation in response to a correlation rule that triggers on a discovery event or a host input event, by default the remediation scans the IP address of the host involved in the event; you do not need to configure this option.
 
      
       
     
 
     
 
     [bookmark: pgfId-2927046]Note Do not assign a Nmap remediation as a response to a correlation rule that triggers on a traffic profile change.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2927047]Step 6 Configure the Scan Type option:
 
      
       
       	 [bookmark: pgfId-2927048]To scan quickly in stealth mode on hosts where the  admin account has raw packet access or where IPv6 is not running, by initiating TCP connections but not completing them, select  TCP Syn Scan . 
 
       	 [bookmark: pgfId-2927049]To scan by using a system  connect() call, which can be used on hosts where the  admin account on your Defense Center does not have raw packet access or where IPv6 is running, select  TCP Connect Scan .
 
       	 [bookmark: pgfId-2927053]To send an ACK packet to check whether ports are filtered or unfiltered, select  TCP ACK Scan .
 
       	 [bookmark: pgfId-2927054]To send an ACK packet to check whether ports are filtered or unfiltered but also determine whether a port is open or closed, select  TCP Window Scan .
 
       	 [bookmark: pgfId-2927055]To identify BSD-derived systems using a FIN/ACK probe, select  TCP Maimon Scan .
 
      
 
     
 
     [bookmark: pgfId-2927056]Step 7 Optionally, to scan UDP ports in addition to TCP ports, select On for the Scan for UDP ports option.
 
      
       
     
 
     
 
     [bookmark: pgfId-2927057]Tip A UDP portscan takes more time than a TCP portscan. To speed up your scans, leave this option disabled.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2927059]Step 8 [bookmark: 14988]If you plan to use this remediation in response to correlation policy violations, configure the Use Port From Event option:
 
      
       
       	 [bookmark: pgfId-2927060]Select  On to scan the port in the correlation event, rather than the ports you specify in step  12 .
 
      
 
     
 
     [bookmark: pgfId-2927064]If you scan the port in the correlation event, note that the remediation scans the port on the IP addresses that you specified in step 8. These ports are also added to the remediation’s dynamic scan target.
 
      
       
       	 [bookmark: pgfId-2927071]Select  Off to scan only the ports you will specify in step  12 .
 
      
 
     
 
     [bookmark: pgfId-2927072]Step 9 If you plan to use this remediation in response to correlation policy violations and want to run the scan using the appliance running the detection engine that detected the event, configure the Scan from reporting detection engine option:
 
      
       
       	 [bookmark: pgfId-2927073]To scan from the appliance running the reporting detection engine, select  On . 
 
       	 [bookmark: pgfId-2927074]To scan from the appliance configured in the remediation, select  Off . 
 
      
 
     
 
     [bookmark: pgfId-2927075]Step 10 Configure the Fast Port Scan option:
 
      
       
       	 [bookmark: pgfId-2927076]To only scan ports listed in the  nmap-services file located in the  /var/sf/nmap/share/nmap/nmap-services directory on the managed device that does the scanning, ignoring other port settings, select  On . 
 
       	 [bookmark: pgfId-2927077]To scan all TCP ports, select  Off . 
 
      
 
     
 
     [bookmark: pgfId-2927078]Step 11 In the Port Ranges and Scan Order field, type the ports you want to scan by default, using Nmap syntax, in the order you want to scan those ports. 
 
     [bookmark: pgfId-2927079]Specify values from 1 to 65535. Separate ports using commas or spaces. You can also use a hyphen to indicate a port range. When scanning for both TCP and UDP ports, preface the list of TCP ports you want to scan with a T and the list of UDP ports with a U. For example, to scan ports 53 and 111 for UDP traffic, then scan ports 21-25 for TCP traffic, enter U:53,111,T:21-25.
 
     [bookmark: pgfId-2927080]Note that the Use Port From Event option overrides this setting when the remediation is launched in response to a correlation policy violation, as described in step 8. 
 
     [bookmark: pgfId-2927085]Step 12 [bookmark: 94937]To probe open ports for server vendor and version information, configure Probe open ports for vendor and version information:
 
      
       
       	 [bookmark: pgfId-2927086]Select  On to scan open ports on the host for server information to identify server vendors and versions.
 
       	 [bookmark: pgfId-2927090]Select  Off to continue using server information for the host.
 
      
 
     
 
     [bookmark: pgfId-2927091]Step 13 If you choose to probe open ports, set the number of probes used by selecting a number from the Service Version Intensity drop-down list:
 
      
       
       	 [bookmark: pgfId-2927092]To use more probes for higher accuracy with a longer scan, select a higher number.
 
       	 [bookmark: pgfId-2927093]To use fewer probes for less accuracy with a faster scan, select a lower number. 
 
      
 
     
 
     [bookmark: pgfId-2927094]Step 14 To scan for operating system information, configure Detect Operating System settings:
 
      
       
       	 [bookmark: pgfId-2927095]Select  On to scan the host for information to identify the operating system.
 
       	 [bookmark: pgfId-2927099]Select  Off to continue using operating system information for the host.
 
      
 
     
 
     [bookmark: pgfId-2927100]Step 15 To determine whether or not host discovery occurs and whether port scans are only run against available hosts, configure Treat All Hosts As Online:
 
      
       
       	 [bookmark: pgfId-2927101]To skip the host discovery process and run a port scan on every host in the target range, select  On . 
 
       	 [bookmark: pgfId-2927102]To perform host discovery using the settings for  Host Discovery Method and  Host Discovery Port List and skip the port scan on any host that is not available, select  Off .
 
      
 
     
 
     [bookmark: pgfId-2927103]Step 16 Select the method to be used when Nmap tests to see if a host is present and available:
 
      
       
       	 [bookmark: pgfId-2927104]To send an empty TCP packet with the SYN flag set and elicit an RST response on a closed port or a SYN/ACK response on an open port on available hosts, select  TCP SYN . 
 
      
 
     
 
     [bookmark: pgfId-2927105]Note that this option scans port 80 by default and that TCP SYN scans are less likely to be blocked by a firewall with stateful firewall rules.
 
      
       
       	 [bookmark: pgfId-2927106]To send an empty TCP packet with the ACK flag set and elicit an RST response on available hosts, select  TCP ACK.  
 
      
 
     
 
     [bookmark: pgfId-2927107]Note that this option scans port 80 by default and that TCP ACK scans are less likely to be blocked by a firewall with stateless firewall rules.
 
      
       
       	 [bookmark: pgfId-2927108]To send a UDP packet to elicit port unreachable responses from closed ports on available hosts, select  UDP . This option scans port 40125 by default.
 
      
 
     
 
     [bookmark: pgfId-2927109]Step 17 If you want to scan a custom list of ports during host discovery, type a list of ports appropriate for the host discovery method you selected, separated by commas, in Host Discovery Port List.
 
     [bookmark: pgfId-2927110]Step 18 Configure the Default NSE Scripts option to control whether to use the default set of Nmap scripts for host discovery and server, operating system, and vulnerability discovery:
 
      
       
       	 [bookmark: pgfId-2927111]To run the default set of Nmap scripts, select  On .
 
       	 [bookmark: pgfId-2927112]To skip the default set of Nmap scripts, select  Off .
 
      
 
     
 
     [bookmark: pgfId-2927114]See http://nmap.org/nsedoc/categories/default.html for the list of default scripts.
 
     [bookmark: pgfId-2927115]Step 19 To set the timing of the scan process, select a timing template number; select a higher number for a faster, less comprehensive scan and a lower number for a slower, more comprehensive scan. 
 
     [bookmark: pgfId-2927116]Step 20 Click Save, then click Done.
 
     [bookmark: pgfId-2927117]The remediation is created.
 
     [bookmark: pgfId-3165288]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2255143][bookmark: 82086]Configuring Set Attribute Rem[bookmark: marker-2286290]ediations
 
     [bookmark: pgfId-2917034]License: FireSIGHT
 
     [bookmark: pgfId-2255403]You can respond to a correlation event by setting a host attribute value on the host where the triggering event occurred. For text host attributes, you can choose to use the description from the event as the attribute value. For more information on host attributes, see Working with the Predefined Host Attributes and Working with User-Defined Host Attributes.
 
     [bookmark: pgfId-2255404]To configure setting an attribute value in response to a correlation event, you must first create a set attribute instance, then add a set attribute remediation. You can then configure attribute value updates as responses to violations of rules within the policy. 
 
     [bookmark: pgfId-2257229]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-2257230]Adding a Set Attribute Value Instance
 
      	 [bookmark: pgfId-2257234]Set Attribute Value Remediations
 
     
 
    
 
     
      [bookmark: pgfId-2255347][bookmark: 24176]Adding a Set Attribute Value Instance
 
     [bookmark: pgfId-2917066]License: FireSIGHT
 
     [bookmark: pgfId-2255144]You can set up an instance to set attribute values in response to correlation rule violations. 
 
     [bookmark: pgfId-2255152]To create a set attribute instance:
 
     [bookmark: pgfId-3016715]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2255153]Step 1 Select Policies > Actions > Instances. 
 
     [bookmark: pgfId-2255154]The Instances page appears.
 
     [bookmark: pgfId-2255155]Step 2 Select Set Attribute Value (v1.0) from the Add a module type drop-down list and click Add.
 
     [bookmark: pgfId-2255156]The Edit Instance page appears.
 
     [bookmark: pgfId-2255161]Step 3 In the Instance Name field, enter a name that includes 1 to 63 alphanumeric characters, with no spaces and no special characters other than underscore (_) and dash (-). 
 
     [bookmark: pgfId-2255162]Step 4 In the Description field, specify a description that includes 0 to 255 alphanumeric characters, including spaces and special characters.
 
     [bookmark: pgfId-2255171]Step 5 Click Create.
 
     [bookmark: pgfId-2255172]The instance is created. 
 
     [bookmark: pgfId-3165323]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2255787][bookmark: 49889]Set Attribute Value Remediations
 
     [bookmark: pgfId-2917094]License: FireSIGHT
 
     [bookmark: pgfId-2255788]You can create a set attribute value remediation for each attribute value you want to be able to set in response to a correlation rule violation. If the attribute you want to set is a text attribute, you can set the remediation to use the description from the event as the attribute value. 
 
     [bookmark: pgfId-2256148]To create a set attribute value remediation:
 
     [bookmark: pgfId-3016748]Access: Admin/Discovery Admin
 
     
 
     [bookmark: pgfId-2255811]Step 1 Select Policies > Actions > Instances. 
 
     [bookmark: pgfId-2255812]The Instances page appears.
 
     [bookmark: pgfId-2255817]Step 2 Click View next to the scan instance where you want to add a remediation.
 
     [bookmark: pgfId-2255818]The Edit Instance page appears.
 
     [bookmark: pgfId-2255823]Step 3 Select Set Attribute Value from the Add a new remediation of type drop-down list.
 
     [bookmark: pgfId-2256947]The Edit Remediation page appears.
 
     [bookmark: pgfId-2255824]Step 4 In the Remediation Name field, type a name for the remediation that includes 1 to 63 alphanumeric characters, with no spaces and no special characters other than underscore (_) and dash (-).
 
     [bookmark: pgfId-2255825]Step 5 In the Description field, type a description for the remediation that includes 0 to 255 alphanumeric characters, including spaces and special characters.
 
     [bookmark: pgfId-3043575]Step 6 If you plan to use this remediation in response to a correlation rule that triggers on an intrusion event, user event, or a connection event, configure the Update Which Host(s) From Event option.
 
      
       
       	 [bookmark: pgfId-2255828]Select  Update Source and Destination Hosts to update the attribute value on the hosts represented by the source IP address and the destination IP address in the event.
 
       	 [bookmark: pgfId-2255829]Select  Update Source Host Only to update the attribute value on the host represented by the event’s source IP address.
 
       	 [bookmark: pgfId-2255830]Select  Update Destination Host Only to update the attribute value on the host represented by the event’s destination IP address.
 
      
 
     
 
     [bookmark: pgfId-2255831]If you plan to use this remediation in response to a correlation rule that triggers on a discovery event or host input event, by default the remediation scans the IP address of the host involved in the event; you do not need to configure this option.
 
     [bookmark: pgfId-2255836]Step 7 Configure the Use Description From Event For Attribute Value (text attributes only) option:
 
      
       
       	 [bookmark: pgfId-2255837]To use the description from the event as the attribute value, select  On . 
 
       	 [bookmark: pgfId-2257013]To use the Attribute Value setting for the remediation as the attribute value, select  Off . 
 
      
 
     
 
     [bookmark: pgfId-2255842]Step 8 If you are not planning to use the event description, type the attribute value you want to set in the Attribute Value field. 
 
     [bookmark: pgfId-2257192]Step 9 Click Save, then click Done.
 
     [bookmark: pgfId-2255880]The remediation is created.
 
     [bookmark: pgfId-3165334]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1748057][bookmark: 14347]Working with Remediation[bookmark: marker-3189275] Status Events
 
    [bookmark: pgfId-2917273]License: FireSIGHT
 
    [bookmark: pgfId-2330155]When a remediation triggers, a remediation status event is generated. These events are logged to the database and can be viewed on the Remediation Status page. You can search, view, and delete remediation status events.
 
    [bookmark: pgfId-2613620]For more information, see:
 
     
     	 [bookmark: pgfId-2613624]Setting Event Time Constraints
 
     	 [bookmark: pgfId-2613628]Searching for Remediation Status Events
 
    
 
     
      [bookmark: pgfId-2618403][bookmark: 46989]Viewing[bookmark: marker-2618400] Remediation Status Events
 
     [bookmark: pgfId-2917340]License: FireSIGHT
 
     [bookmark: pgfId-2387770]The page you see when you access remediation status events differs depending on the workflow you use. You can use the predefined workflow, which includes a table view of remediations. The table view contains a row for each remediation status event. You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
     [bookmark: pgfId-3135478]The following table describes some of the specific actions you can perform on a remediation status events workflow page.
 
     [bookmark: pgfId-3135577]
 
      
       
        
        [bookmark: pgfId-3159501]Table 54-1 Options for Viewing Remediation Status Events 
 
        
        
         
         	 
           
           [bookmark: pgfId-3135489]To... 
          
  
         	 
           
           [bookmark: pgfId-3135491]You can... 
          
  
        
 
         
         	[bookmark: pgfId-3135493]learn more about the columns that appear
  
         	[bookmark: pgfId-3135497]find more information in Understanding the Remediation Status Table.
  
        
 
         
         	[bookmark: pgfId-3135500]modify the time and date range for displayed events
  
         	[bookmark: pgfId-3135504]see Setting Event Time Constraints.
 [bookmark: pgfId-3135506]Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This can occur even if you configured a sliding time window for the appliance.
  
        
 
         
         	[bookmark: pgfId-3135508]sort and constrain the events
  
         	[bookmark: pgfId-3135513]see Constraining Events and Sorting Drill-Down Workflow Pages.
  
        
 
         
         	[bookmark: pgfId-3135518]temporarily use a different workflow
  
         	[bookmark: pgfId-3135520]click (switch workflow) by the workflow title. For more information, see Selecting Workflows.
  
        
 
         
         	[bookmark: pgfId-3135525]navigate to the correlation events view to see associated events
  
         	[bookmark: pgfId-3135527]click Correlation Events. For more information, see Navigating Between Workflows.
  
        
 
         
         	[bookmark: pgfId-3135532]bookmark the current page so that you can quickly return to it
  
         	[bookmark: pgfId-3135534]click Bookmark This Page. For more information, see Using Bookmarks.
  
        
 
         
         	[bookmark: pgfId-3135539]navigate to the bookmark management page
  
         	[bookmark: pgfId-3135541]click View Bookmarks. For more information, see Using Bookmarks.
  
        
 
         
         	[bookmark: pgfId-3135546]generate a report based on the data in the table view
  
         	[bookmark: pgfId-3135548]click Report Designer. For more information, see Creating a Report Template from an Event View.
  
        
 
         
         	[bookmark: pgfId-3135553]drill down to the next page in the workflow, constraining on a specific value
  
         	[bookmark: pgfId-3135555]use one of the following methods:
 
           
           	 [bookmark: pgfId-3135556]on a drill-down page that you created in a custom workflow, click  a value within a row. Note that clicking a value within a row in a table view constrains the table view and does  not drill down to the next page.
 
           	 [bookmark: pgfId-3135557]To drill down to the next workflow page constraining on some users, select the check boxes next to the users you want to view on the next workflow page, then click  View .
 
           	 [bookmark: pgfId-3135558]To drill down to the next workflow page keeping the current constraints, click  View All .
 
          
 [bookmark: pgfId-3135559]Tip Table views always include “Table View” in the page name. [bookmark: pgfId-3135562]For more information, see Constraining Events.
  
        
 
         
         	[bookmark: pgfId-3135565]delete remediation status events from the system
  
         	[bookmark: pgfId-3135567]use one of the following methods:
 
           
           	 [bookmark: pgfId-3135568]To delete some events, select the check boxes next to events you want to delete, then click  Delete .
 
           	 [bookmark: pgfId-3135569]To delete all events in the current constrained view, click  Delete All , then confirm you want to delete all the events.
 
          
  
        
 
         
         	[bookmark: pgfId-3135571]search for remediation status events
  
         	[bookmark: pgfId-3135573]click Search. For more information, see Searching for Remediation Status Events.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2387913]To view remediation status events:
 
     [bookmark: pgfId-2387914]Access: Admin 
 
     
 
     [bookmark: pgfId-2387915]Step 1 Select Analysis > Correlation > Status.
 
     [bookmark: pgfId-2387916]The first page of the default remediations workflow appears. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range; see Setting Event Time Constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-2387923]Tip If you are using a custom workflow that does not include the table view of remediations, click (switch workflow) menu by the workflow title, then select Remediation Status.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3165402]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2387702]Working wit[bookmark: WorkingRemediationStatusEventsTableView]h Remediation Status Events
 
     [bookmark: pgfId-2917368]License: FireSIGHT
 
     [bookmark: pgfId-3061360]You can change the layout of the event view or constrain the events in the view by a field value. 
 
     [bookmark: pgfId-3061366]When you disable a column, it is disabled for the duration of your session (unless you add it back later). Note that when you disable the first column, the Count column is added.
 
     [bookmark: pgfId-3082949]Clicking a value within a row in a table view constrains the table view and does not drill down to the next page. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3082950]Tip Table views always include “Table View” in the page name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3082951]For more information, see the following topics:
 
      
      	 [bookmark: pgfId-2387715]Constraining Events.
 
      	 [bookmark: pgfId-2387719]Using Compound Constraints.
 
      	 [bookmark: pgfId-2387723]Sorting Drill-Down Workflow Pages.
 
      	 [bookmark: pgfId-2387727]Understanding the Remediation Status Table
 
     
 
    
 
     
      [bookmark: pgfId-1985852][bookmark: 44970]Understanding the[bookmark: marker-2093333] Remediation Status Table
 
     [bookmark: pgfId-2917392]License: FireSIGHT
 
     [bookmark: pgfId-1985856]You can configure the Defense Center to launch a variety of responses to policy violations and to discovery events. These responses include remediations, such as blocking a host at the firewall or router when it violates a policy. When a remediation triggers, a remediation status event is generated and logged to the database. For more information on remediations, see Configuring Remediations.
 
     [bookmark: pgfId-1985865]The fields in the remediation status table are[bookmark: marker-2093334] described in the following table.
 
     [bookmark: pgfId-1985916]
 
      
       
        
        [bookmark: pgfId-1985873]Table 54-2 [bookmark: 38391]Remediation Status Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-1985877]Field 
          
  
         	 
           
           [bookmark: pgfId-1985879]Description 
          
  
        
 
         
         	[bookmark: pgfId-1985881]Policy
  
         	[bookmark: pgfId-1985883]The name of the correlation policy that was violated and triggered the remediation.
  
        
 
         
         	[bookmark: pgfId-1985885]Remediation Name
  
         	[bookmark: pgfId-1985887]The name of the remediation that was launched.
  
        
 
         
         	[bookmark: pgfId-1985889]Result Message
  
         	[bookmark: pgfId-1985891]A message that describes what happened when the remediation was launched. Status messages include:
 
           
           	 [bookmark: pgfId-1985892]Successful completion of remediation
 
           	 [bookmark: pgfId-1985893]Error in the input provided to the remediation module
 
           	 [bookmark: pgfId-1985894]Error in the remediation module configuration 
 
           	 [bookmark: pgfId-1985895]Error logging into the remote device or server
 
           	 [bookmark: pgfId-1985896]Unable to gain required privileges on remote device or server
 
           	 [bookmark: pgfId-1985897]Timeout logging into remote device or server
 
           	 [bookmark: pgfId-1985898]Timeout executing remote commands or servers
 
           	 [bookmark: pgfId-1985899]The remote device or server was unreachable
 
           	 [bookmark: pgfId-1985900]The remediation was attempted but failed
 
           	 [bookmark: pgfId-1985902]Failed to execute remediation program
 
           	 [bookmark: pgfId-1985903]Unknown/unexpected error
 
          
 [bookmark: pgfId-1985904]Note If custom remediation modules are installed, you may see additional status messages that are implemented by the custom module.
  
        
 
         
         	[bookmark: pgfId-1985906]Rule
  
         	[bookmark: pgfId-1985908]The name of the rule that triggered the remediation.
  
        
 
         
         	[bookmark: pgfId-1985910]Time
  
         	[bookmark: pgfId-1985915]The date and time that the Defense Center launched the remediation
  
        
 
         
         	[bookmark: pgfId-2722714]Count
  
         	[bookmark: pgfId-2722716]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1985917]To display the table view of remediation status events:
 
     [bookmark: pgfId-2331840]Access: Admin 
 
     
 
     [bookmark: pgfId-1985918]Step 1 Select Analysis > Correlation > Status.
 
     [bookmark: pgfId-1985919]The table view appears. For information on working with remediation status events, see Working with Remediation Status Events.
 
      
       
     
 
     
 
     [bookmark: pgfId-1985923]Tip If you are using a custom workflow that does not include the table view of remediation status events, click (switch workflow) by the workflow title, then click Remediation Status.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3165428]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1805725][bookmark: RemediationSearch][bookmark: 56339]Searching[bookmark: marker-2093335] for Remediation Status Events
 
     [bookmark: pgfId-2917412]License: FireSIGHT
 
     [bookmark: pgfId-2385055]You can search for remediation status events to determine when and if a particular remediation was launched. You may want to create searches customized for your network environment, then save them to reuse later. The search criteria you can use are described in the following table.
 
     [bookmark: pgfId-1807930]
 
      
       
        
        [bookmark: pgfId-1807482]Table 54-3 [bookmark: 24628]Remediation Status Search Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-1807486]Search Field 
          
  
         	 
           
           [bookmark: pgfId-1807488]Description 
          
  
        
 
         
         	[bookmark: pgfId-1807491]Result Message
  
         	[bookmark: pgfId-1807775]Enter the exact name of the result message (a message that describes what happened when the remediation was launched) you want to match. Valid status messages are:
 
           
           	 [bookmark: pgfId-1807755]Successful completion of remediation
 
           	 [bookmark: pgfId-1807756]Error in the input provided to the remediation module
 
           	 [bookmark: pgfId-1807757]Error in the remediation module configuration 
 
           	 [bookmark: pgfId-1807758]Error logging into the remote device or server
 
           	 [bookmark: pgfId-1807759]Unable to gain required privileges on remote device or server
 
           	 [bookmark: pgfId-1807760]Timeout logging into remote device or server
 
           	 [bookmark: pgfId-1807761]Timeout executing remote commands or servers
 
           	 [bookmark: pgfId-1807762]The remote device or server was unreachable
 
           	 [bookmark: pgfId-1807763]The remediation was attempted but failed
 
           	 [bookmark: pgfId-1807765]Failed to execute remediation program
 
           	 [bookmark: pgfId-1807766]Unknown/unexpected error
 
          
 [bookmark: pgfId-1807767]Note If you installed custom remediation modules, you may be able to enter additional status messages implemented by the custom module.
  
        
 
         
         	[bookmark: pgfId-1807498]Time
  
         	[bookmark: pgfId-1807848]Specify the date and time the Defense Center launched the remediation. See Specifying Time Constraints in Searches for the syntax for entering time.
  
        
 
         
         	[bookmark: pgfId-1807505]Remediation Name
  
         	[bookmark: pgfId-1807824]Enter the exact name of the remediation that was launched. This is the name you specified when you created the remediation.
  
        
 
         
         	[bookmark: pgfId-1807512]Policy
  
         	[bookmark: pgfId-1807869]Enter the name of the correlation policy that triggered the remediation.
  
        
 
         
         	[bookmark: pgfId-1807687]Rule
  
         	[bookmark: pgfId-1807897]Enter the name of the correlation rule that triggered the remediation.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1807523]For more information on searching, including how to load and delete saved searches, see Searching for Events.
 
     [bookmark: pgfId-3016444]To search for remediation status events:
 
     [bookmark: pgfId-3016445]Access: Admin 
 
     
 
     [bookmark: pgfId-3016446]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-1807530]The search page appears.
 
     [bookmark: pgfId-3179322]Step 2 From the table drop-down menu, select Remediation Status.
 
      
       
     
 
     
 
     [bookmark: pgfId-1807536]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1807540]Step 3 Enter your search criteria in the appropriate fields, as described in the Remediation Status Search Criteria table. 
 
     [bookmark: pgfId-3179397]If you enter criteria for multiple fields, the search returns only the records that match search criteria specified for all fields.
 
     [bookmark: pgfId-1807546]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-2057951]Tip If you want to save a search as a restriction for restricted event analyst users, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1807548]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-3179509]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-3179510]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-3179511]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-3179512]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-1807549]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-2370383]Your search results appear in the default remediation status workflow, constrained by the current time range. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-3165456]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1787933]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-4296647][bookmark: 90386]Using Dashbo[bookmark: marker-4296646]ards 
      
      
 
     
 
 
    [bookmark: pgfId-4296651]The FireSIGHT System dashboard provides you with at-a-glance views of current system status, including data about the events collected and generated by the system. You can also use the dashboard to see information about the status and overall health of the appliances in your deployment. Only certain user roles (Administrator, Maintenance User, Security Analyst, Security Analyst [Read Only], and custom roles with the Dashboards permission) have access to the dashboard. Other roles see as their default start pages a page relevant to the role; for example, a Discovery Admin sees the Network Discovery page.
 
    [bookmark: pgfId-4296653]A dashboard has one or more tabs, each of which can display one or more widgets in a three-column layout. Widgets are small, self-contained components that provide insight into different aspects of the FireSIGHT System. The FireSIGHT System is delivered with several predefined widgets. For example, the Appliance Information widget tells you the appliance name, model, remote manager, and currently running version of the FireSIGHT System software.
 
    [bookmark: pgfId-4296663]The dashboard has a time range that constrains its widgets. You can change the time range to reflect a period as short as the last hour or as long as the last year.
 
    [bookmark: pgfId-4296664]The dashboard is a complex, highly customizable monitoring feature. Another way to view many types of system data is the Context Explorer, which presents information using intrusion, connection, and discovery data in a set of preset visual contexts that you change, only temporarily, with filters to add granularity. In contrast to the exhaustive data available in the FireSIGHT System dashboard, the Context Explorer offers a broad, brief, and colorful picture of how your monitored network looks and acts. For more information on the Context Explorer, see Using the Context Explorer.
 
    [bookmark: pgfId-4296673]Each type of ap[bookmark: marker-4296671]pliance is delivered with a default dashboard, named Sum[bookmark: marker-4296672]mary Dashboard. This dashboard provides the casual user with general FireSIGHT, intrusion, threat detection, geolocation, and system status information for your FireSIGHT System deployment. Note that because some widgets are useful only for specific types of appliances, the Summary Dashboard differs depending on whether you are using a Defense Center, virtual Defense Center, or managed device. 
 
     
      
    
 
    
 
    [bookmark: pgfId-4363783]Note Virtual managed devices do not have a web interface and do not support dashboards.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4296687]By default, the [bookmark: marker-4296686]home page for your appliance displays the Summary Dashboard, although you can configure your appliance to display a different default home page.
 
     
      
    
 
    
 
    [bookmark: pgfId-4296688]Tip If you change the home page, you can access dashboards by selecting Overview > Dashboards. For more information, see Viewing Dashboards.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4296692]Note that the data displayed depends on such factors as how you license and deploy your managed devices, whether you configure features that provide the data and, in the case of Series 2 appliances and Cisco NGIPS for Blue Coat X-Series, whether the appliance supports a feature that provides the data. For example, because neither the DC500 Defense Center nor Series 2 devices support URL filtering by category and reputation, the DC500 Defense Center does not display data for this feature and Series 2 devices do not detect this data.
 
    [bookmark: pgfId-4296717]In addition to the Summary Dashboard, the Defense Center is delivered with the following predefined dashboards:
 
     
     	 [bookmark: pgfId-4296719]The Appli[bookmark: marker-4296718]cation Statistics dashboard provides detailed information about application activity and intrusion events on your monitored network. You can use this dashboard to track which applications produce the most traffic, allowed and denied connections, and intrusion events, as well as the number of unique applications in use and the estimated risk and business relevance of those applications.
 
     	 [bookmark: pgfId-4296721]The Connecti[bookmark: marker-4296720]on Summary dashboard uses connection data to create tables and charts of the activity on your monitored network. You can use this dashboard to track the ports, applications, and initiator and responder IPs associated with connections and traffic on your network, the overall volume of connections and traffic, and geolocation information. You must log connections for this dashboard to generate data; see Understanding Connection and Security Intelligence Data. Note that the output of this widget depends on your connection logging configuration.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-4296725]Tip Widgets on this dashboard list total traffic in kilobytes (KB). The total traffic in KB is equal to the traffic in KB/s multiplied by the total seconds covered by the selected time window. 
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-4296727]The Detailed [bookmark: marker-4296726]Dashboard provides advanced users with detailed information about their FireSIGHT System deployment and includes multiple widgets that summarize collected intrusion event, network discovery, compliance, correlation, traffic, and system status data, as well as providing information about Cisco news and product updates. You can use this dashboard to monitor a very broad variety of network information at once.
 
     	 [bookmark: pgfId-4296735]The Files Dashbo[bookmark: marker-4296734]ard provides detailed information about the files (including malware files) detected on your network by managed devices, captured files stored on devices and submitted for dynamic analysis, and malware detected using a subscription-based FireAMP strategy. Note that you must have a Malware license and enable malware detection for this dashboard to include network-based malware data. Also, neither the DC500 nor Series 2 devices or Cisco NGIPS for Blue Coat X-Series support advanced malware protection, so the DC500 cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. For more information, see Understanding Malware Protection and File Control.
 
     	 [bookmark: pgfId-4296758]The URL S[bookmark: marker-4296757]tatistics dashboard provides detailed information about allowed and denied traffic from your monitored network to external URLs, sorted by URL category and reputation. Note that you must have a URL Filtering license and enable URL Filtering for this dashboard to include URL category and reputation data. Note also that neither the DC500 nor Series 2 devices support URL filtering by reputation and category, so the DC500 cannot display this data and Series 2 devices do not detect it. See Performing Reputation-Based URL Blocking.
 
     	 [bookmark: pgfId-4296781]The Access Controlled User Statis[bookmark: marker-4296780]tics dashboard provides detailed information about user activity and intrusion events on your monitored network. You can use this dashboard to track allowed and denied connections, traffic, and intrusion events associated with users on your network, as well as the number of unique users on the network. Because this dashboard depends on user awareness data, for this dashboard to display meaningful statistics you must configure at least one User Agent and a Defense Center-Active Directory LDAP server connection; see Using User Agents to Report Active Directory Logins.
 
    
 
    [bookmark: pgfId-4296791]You can use the predefined dashboards, modify the predefined dashboards, or create a custom dashboard to suit your needs. You can share custom dashboards among all users of an appliance, or you can create a custom dashboard solely for your own use. You can also set a custom dashboard as your default dashboard.
 
    [bookmark: pgfId-4296792]Some drill-down pages and table views of events include a Dashboard toolbar link that you can click to view a relevant predefined dashboard. The following table lists which event views correspond to which predefined dashboards. Note that if you delete a predefined dashboard or tab, the associated Dashboard links do not function.
 
    [bookmark: pgfId-4296874]
 
     
      
       
       [bookmark: pgfId-4296802]Table 55-1 [bookmark: 47591]Event Table Dashboard Links 
 
       
       
        
        	 
          
          [bookmark: pgfId-4296806]Table 
         
  
        	 
          
          [bookmark: pgfId-4296808]Dashboard Link 
         
  
       
 
        
        	[bookmark: pgfId-4296810]Connection Events
 [bookmark: pgfId-4296811](Analysis > Connections > Events)
  
        	[bookmark: pgfId-4296813]Connection Summary
  
       
 
        
        	[bookmark: pgfId-4296815]Security Intelligence Events
 [bookmark: pgfId-4296816](Analysis > Connections > Security Intelligence)
  
        	[bookmark: pgfId-4296818]Connection Summary
  
       
 
        
        	[bookmark: pgfId-4296820]Intrusion Events
 [bookmark: pgfId-4296821](Analysis > Intrusions > Events)
  
        	[bookmark: pgfId-4296823]Summary (Intrusion Events tab)
  
       
 
        
        	[bookmark: pgfId-4296825]Malware Events
 [bookmark: pgfId-4296826](Analysis > Files > Malware Events)
  
        	[bookmark: pgfId-4296828]Files (Malware tab)
  
       
 
        
        	[bookmark: pgfId-4296830]File Events
 [bookmark: pgfId-4296831](Analysis > Files > File Events)
  
        	[bookmark: pgfId-4296833]Files (Files tab)
  
       
 
        
        	[bookmark: pgfId-4296835]Captured Files
 [bookmark: pgfId-4296836](Analysis > Files > Captured Files)
  
        	[bookmark: pgfId-4296838]Files (File Storage tab)
  
       
 
        
        	[bookmark: pgfId-4296840]Applications
 [bookmark: pgfId-4296841](Analysis > Hosts > Applications)
  
        	[bookmark: pgfId-4296843]Application Statistics
  
       
 
        
        	[bookmark: pgfId-4296845]Application Details
 [bookmark: pgfId-4296846](Analysis > Hosts > Application Details)
  
        	[bookmark: pgfId-4296848]Application Statistics
  
       
 
        
        	[bookmark: pgfId-4296850]Indications of Compromise
 [bookmark: pgfId-4296851](Analysis > Hosts > Indications of Compromise)
  
        	[bookmark: pgfId-4296853]Summary (Threats tab)
  
       
 
        
        	[bookmark: pgfId-4296855]Users
 [bookmark: pgfId-4296856](Analysis > Users > Users)
  
        	[bookmark: pgfId-4296858]Access Controlled User Statistics
  
       
 
        
        	[bookmark: pgfId-4296860]User Activity
 [bookmark: pgfId-4296861](Analysis > Users > User Activity)
  
        	[bookmark: pgfId-4374113]Access Controlled User Statistics
  
       
 
        
        	[bookmark: pgfId-4296865]Correlation Events
 [bookmark: pgfId-4296866](Analysis > Correlation > Correlation Events)
  
        	[bookmark: pgfId-4296868]Detailed (Correlation tab)
  
       
 
        
        	[bookmark: pgfId-4296870]White List Events
 [bookmark: pgfId-4296871](Analysis > Correlation > White List Events)
  
        	[bookmark: pgfId-4296873]Detailed (Correlation tab)
  
       
 
       
     
 
    
 
    [bookmark: pgfId-4296875]For more information on dashboards and their contents, see the following sections:
 
     
     	 [bookmark: pgfId-4296879]Understanding Dashboard Widgets
 
     	 [bookmark: pgfId-4296883]Understanding the Predefined Widgets
 
     	 [bookmark: pgfId-4296887]Working with Dashboards
 
    
 
   
 
    
     [bookmark: pgfId-4296890][bookmark: 35085]Understanding Dash[bookmark: marker-4296889]board Widgets
 
    [bookmark: pgfId-4296891]License: Any
 
    [bookmark: pgfId-4296892]A dashboard has one or more tabs, each of which can display one or more widgets in a three-column layout. The FireSIGHT System is delivered with many predefined dashboard widgets, each of which provides insight into a different aspect of the FireSIGHT System. Widgets are grouped into three categories:
 
     
     	 [bookmark: pgfId-4296899] Analysis & Reporting widgets display data about the events collected and generated by the FireSIGHT System.
 
     	 [bookmark: pgfId-4296903] Miscellaneous widgets display neither event data nor operations data. Currently, the only widget in this category displays an RSS feed.
 
     	 [bookmark: pgfId-4296904] Operations widgets display information about the status and overall health of the FireSIGHT System.
 
    
 
    [bookmark: pgfId-4296908]The dashboard widgets that you can view depend on the type of appliance you are using and on your user role. In addition, each dashboard has a set of preferences that determines its behavior. You can minimize and maximize widgets, add and remove widgets from tabs, as well as rearrange the widgets on a tab.
 
     
      
    
 
    
 
    [bookmark: pgfId-4296909]Note For widgets that display event counts over a time range, the total number of events may not reflect the number of events for which detailed data is available in the event viewer. This occurs because the system sometimes prunes older event details to manage disk space usage. To minimize the occurrence of event detail pruning, you can fine-tune event logging to log only those events most important to your deployment. For more information, see Logging Connections in Network Traffic.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4296913]For more information, see: 
 
     
     	 [bookmark: pgfId-4296917]Understanding Widget Availability
 
     	 [bookmark: pgfId-4296921]Understanding Widget Preferences
 
     	 [bookmark: pgfId-4296925]Understanding the Predefined Widgets
 
     	 [bookmark: pgfId-4296929]Working with Dashboards
 
    
 
     
      [bookmark: pgfId-4296932][bookmark: 19269]Understanding Widget A[bookmark: marker-4296931]vailability
 
     [bookmark: pgfId-4296933]License: Any
 
     [bookmark: pgfId-4296937]The FireSIGHT System is delivered with several predefined dashboard widgets. The dashboard widgets that you can view depend on the type of appliance you are using and on your user role:
 
      
      	 [bookmark: pgfId-4296939]An  invalid [bookmark: marker-4296938] widget is one that you cannot view because you are using the wrong type of appliance.
 
      	 [bookmark: pgfId-4296941]An  unauthorized [bookmark: marker-4296940] widget is one that you cannot view because you do not have the necessary account privileges.
 
     
 
     [bookmark: pgfId-4296942]For example, the Current Sessions widget is available on all appliances, but only to users with Administrator account privileges, while the Appliance Status widget is available only on the Defense Center for users with Administrator, Maintenance User, Security Analyst, or Security Analyst (Read Only) account privileges.
 
     [bookmark: pgfId-4296946]Although you cannot add an unauthorized or invalid widget to a dashboard, if you import a dashboard created either on a different kind of appliance or by a user with different access privileges, that dashboard may contain unauthorized or invalid widgets. These widgets are disabled and display error messages that indicate the reason why you cannot view them.
 
     [bookmark: pgfId-4296947]Also note that widgets cannot display data to which an appliance has no access. For example, managed devices cannot access correlation events, intrusion events, discovery events, and so on. If you import a dashboard onto a managed device that contains a Custom Analysis widget configured to display one of those data types, the widget displays an error message. Individual widgets also display error messages when those widgets have timed out or are otherwise experiencing problems.
 
     [bookmark: pgfId-4296948]The content of a widget can differ depending on the type of appliance you are using. For example, the Custom Analysis widget on a Defense Center can display discovery information, but this feature is not available when you configure the Custom Analysis widget on a managed device. Note than you can sort any content generated in table format by clicking on the table column header.
 
     [bookmark: pgfId-4296952]You can delete or minimize unauthorized and invalid widgets, as well as widgets that display no data, keeping in mind that modifying a widget on a shared dashboard modifies it for all users of the appliance. For more information, see Minimizing and Maximizing Widgets and Deleting Widgets.
 
      
       
        
        [bookmark: pgfId-4296972]Table 55-2 [bookmark: 77811]FirePOWER Appliances and Dashboard Widget Availability 
 
        
        
         
         	 
           
           [bookmark: pgfId-4296978]Widget 
          
  
         	 
           
           [bookmark: pgfId-4296983]Defense Center 
          
  
         	 
           
           [bookmark: pgfId-4296985]Any Managed Device 
          
  
        
 
         
         	[bookmark: pgfId-4296987]Appliance Information
  
         	[bookmark: pgfId-4296989]yes
  
         	[bookmark: pgfId-4296991]yes
  
        
 
         
         	[bookmark: pgfId-4296993]Appliance Status
  
         	[bookmark: pgfId-4296995]yes
  
         	[bookmark: pgfId-4296997]no
  
        
 
         
         	[bookmark: pgfId-4296999]Correlation Events
  
         	[bookmark: pgfId-4297001]yes
  
         	[bookmark: pgfId-4297003]no
  
        
 
         
         	[bookmark: pgfId-4297005]Current Interface Status
  
         	[bookmark: pgfId-4297007]yes
  
         	[bookmark: pgfId-4297009]yes
  
        
 
         
         	[bookmark: pgfId-4297011]Current Sessions
  
         	[bookmark: pgfId-4297013]yes
  
         	[bookmark: pgfId-4297015]yes
  
        
 
         
         	[bookmark: pgfId-4297017]Custom Analysis
  
         	[bookmark: pgfId-4297019]yes
  
         	[bookmark: pgfId-4297021]no
  
        
 
         
         	[bookmark: pgfId-4297023]Disk Usage
  
         	[bookmark: pgfId-4297025]yes
  
         	[bookmark: pgfId-4297027]yes
  
        
 
         
         	[bookmark: pgfId-4297029]Interface Traffic
  
         	[bookmark: pgfId-4297031]yes
  
         	[bookmark: pgfId-4297033]yes
  
        
 
         
         	[bookmark: pgfId-4297035]Intrusion Events
  
         	[bookmark: pgfId-4297037]yes
  
         	[bookmark: pgfId-4297039]no
  
        
 
         
         	[bookmark: pgfId-4297041]Network Compliance
  
         	[bookmark: pgfId-4297043]yes
  
         	[bookmark: pgfId-4297045]no
  
        
 
         
         	[bookmark: pgfId-4297047]Product Licensing
  
         	[bookmark: pgfId-4297049]yes
  
         	[bookmark: pgfId-4297051]no
  
        
 
         
         	[bookmark: pgfId-4297053]Product Updates
  
         	[bookmark: pgfId-4297055]yes
  
         	[bookmark: pgfId-4297057]yes
  
        
 
         
         	[bookmark: pgfId-4297059]RSS Feed
  
         	[bookmark: pgfId-4297061]yes
  
         	[bookmark: pgfId-4297063]yes
  
        
 
         
         	[bookmark: pgfId-4297065]System Load
  
         	[bookmark: pgfId-4297067]yes
  
         	[bookmark: pgfId-4297069]yes
  
        
 
         
         	[bookmark: pgfId-4297071]System Time
  
         	[bookmark: pgfId-4297073]yes
  
         	[bookmark: pgfId-4297075]yes
  
        
 
         
         	[bookmark: pgfId-4297077]White List Events
  
         	[bookmark: pgfId-4297079]yes
  
         	[bookmark: pgfId-4297081]no
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4297086] The following table lists the user account privileges required to view each widget. Only user accounts with Administrator, Maintenance User, Security Analyst, or Security Analyst (Read Only) access can use dashboards.
 
      
       
        
        [bookmark: pgfId-4297094]Table 55-3 [bookmark: 94815]User Roles and Dashboard Widget Availability 
 
        
        
         
         	 
           
           [bookmark: pgfId-4297104]Widget 
          
  
         	 
           
           [bookmark: pgfId-4297106]Administrator 
          
  
         	 
           
           [bookmark: pgfId-4297108]Maintenance User 
          
  
         	 
           
           [bookmark: pgfId-4297110]Security Analyst 
          
  
         	 
           
           [bookmark: pgfId-4297112]Security Analyst (RO) 
          
  
        
 
         
         	[bookmark: pgfId-4297114]Appliance Information
  
         	[bookmark: pgfId-4297116]yes
  
         	[bookmark: pgfId-4297118]yes
  
         	[bookmark: pgfId-4297120]yes
  
         	[bookmark: pgfId-4297122]yes
  
        
 
         
         	[bookmark: pgfId-4297124]Appliance Status
  
         	[bookmark: pgfId-4297126]yes
  
         	[bookmark: pgfId-4297128]yes
  
         	[bookmark: pgfId-4297130]yes
  
         	[bookmark: pgfId-4297132]no
  
        
 
         
         	[bookmark: pgfId-4297134]Correlation Events
  
         	[bookmark: pgfId-4297136]yes
  
         	[bookmark: pgfId-4297138]no
  
         	[bookmark: pgfId-4297140]yes
  
         	[bookmark: pgfId-4297142]yes
  
        
 
         
         	[bookmark: pgfId-4297144]Current Interface Status
  
         	[bookmark: pgfId-4297146]yes
  
         	[bookmark: pgfId-4297148]yes
  
         	[bookmark: pgfId-4297150]yes
  
         	[bookmark: pgfId-4297152]yes
  
        
 
         
         	[bookmark: pgfId-4297154]Current Sessions
  
         	[bookmark: pgfId-4297156]yes
  
         	[bookmark: pgfId-4297158]no
  
         	[bookmark: pgfId-4297160]no
  
         	[bookmark: pgfId-4297162]no
  
        
 
         
         	[bookmark: pgfId-4297164]Custom Analysis
  
         	[bookmark: pgfId-4297166]yes
  
         	[bookmark: pgfId-4297168]no
  
         	[bookmark: pgfId-4297170]yes
  
         	[bookmark: pgfId-4297172]yes
  
        
 
         
         	[bookmark: pgfId-4297174]Disk Usage
  
         	[bookmark: pgfId-4297176]yes
  
         	[bookmark: pgfId-4297178]yes
  
         	[bookmark: pgfId-4297180]yes
  
         	[bookmark: pgfId-4297182]yes
  
        
 
         
         	[bookmark: pgfId-4297184]Interface Traffic
  
         	[bookmark: pgfId-4297186]yes
  
         	[bookmark: pgfId-4297188]yes
  
         	[bookmark: pgfId-4297190]yes
  
         	[bookmark: pgfId-4297192]yes
  
        
 
         
         	[bookmark: pgfId-4297194]Intrusion Events
  
         	[bookmark: pgfId-4297196]yes
  
         	[bookmark: pgfId-4297198]no
  
         	[bookmark: pgfId-4297200]yes
  
         	[bookmark: pgfId-4297202]yes
  
        
 
         
         	[bookmark: pgfId-4297204]Network Compliance
  
         	[bookmark: pgfId-4297206]yes
  
         	[bookmark: pgfId-4297208]no
  
         	[bookmark: pgfId-4297210]yes
  
         	[bookmark: pgfId-4297212]yes
  
        
 
         
         	[bookmark: pgfId-4297214]Product Licensing
  
         	[bookmark: pgfId-4297216]yes
  
         	[bookmark: pgfId-4297218]yes
  
         	[bookmark: pgfId-4297220]no
  
         	[bookmark: pgfId-4297222]no
  
        
 
         
         	[bookmark: pgfId-4297224]Product Updates
  
         	[bookmark: pgfId-4297226]yes
  
         	[bookmark: pgfId-4297228]yes
  
         	[bookmark: pgfId-4297230]no
  
         	[bookmark: pgfId-4297232]no
  
        
 
         
         	[bookmark: pgfId-4297234]RSS Feed
  
         	[bookmark: pgfId-4297236]yes
  
         	[bookmark: pgfId-4297238]yes
  
         	[bookmark: pgfId-4297240]yes
  
         	[bookmark: pgfId-4297242]yes
  
        
 
         
         	[bookmark: pgfId-4297244]System Load
  
         	[bookmark: pgfId-4297246]yes
  
         	[bookmark: pgfId-4297248]yes
  
         	[bookmark: pgfId-4297250]yes
  
         	[bookmark: pgfId-4297252]yes
  
        
 
         
         	[bookmark: pgfId-4297254]System Time
  
         	[bookmark: pgfId-4297256]yes
  
         	[bookmark: pgfId-4297258]yes
  
         	[bookmark: pgfId-4297260]yes
  
         	[bookmark: pgfId-4297262]yes
  
        
 
         
         	[bookmark: pgfId-4297264]White List Events
  
         	[bookmark: pgfId-4297266]yes
  
         	[bookmark: pgfId-4297268]no
  
         	[bookmark: pgfId-4297270]yes
  
         	[bookmark: pgfId-4297272]yes
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-4297276][bookmark: 77484]Understanding Widg[bookmark: marker-4297275]et Preferences
 
     [bookmark: pgfId-4297277]License: Any
 
     [bookmark: pgfId-4297278]Each widget has a set of preferences that determines its behavior.
 
     [bookmark: pgfId-4297279]Widget preferences can be simple. For example, the following graphic shows the preferences for the Current Interface Status widget, which displays the current status of all enabled interfaces on the internal network. You can only configure the update frequency for this widget.
 
     [bookmark: pgfId-4297280]Widget preferences can also be more complex. For example, the following graphic shows the preferences for the Custom Analysis widget, which is a highly customizable widget that allows you to display detailed information on the events collected and generated by the FireSIGHT System.
 
     [bookmark: pgfId-4297284]To modify a widget’s preferences:
 
     [bookmark: pgfId-4297285]Access: Admin/Any Security Analyst/Maint
 
     
 ). 
     
 
     [bookmark: pgfId-4297290]The preferences section for that widget appears.
 
     [bookmark: pgfId-4297291]Step 2 Make changes as needed.
 
     [bookmark: pgfId-4297292]Your changes take effect immediately. For information on the preferences you can specify for individual widgets, see Understanding the Predefined Widgets.
 ) to hide the preferences section. 
     
 
     [bookmark: pgfId-4331135]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4297302][bookmark: 47157]Understanding the Predefin[bookmark: marker-4297301]ed Widgets
 
    [bookmark: pgfId-4297303]License: Any
 
    [bookmark: pgfId-4297307]The FireSIGHT System is delivered with several predefined widgets that, when used on dashboards, can provide you with at-a-glance views of current system status, including data about the events collected and generated by the system, as well as information about the status and overall health of the appliances in your deployment.
 
    [bookmark: pgfId-4297311]For detailed information on the widgets delivered with the FireSIGHT System, see the following sections:
 
     
     	 [bookmark: pgfId-4297315]Understanding the Appliance Information Widget
 
     	 [bookmark: pgfId-4297319]Understanding the Appliance Status Widget
 
     	 [bookmark: pgfId-4297323]Understanding the Correlation Events Widget
 
     	 [bookmark: pgfId-4297327]Understanding the Current Interface Status Widget
 
     	 [bookmark: pgfId-4297331]Understanding the Current Sessions Widget
 
     	 [bookmark: pgfId-4297335]Understanding the Custom Analysis Widget
 
     	 [bookmark: pgfId-4297339]Understanding the Disk Usage Widget
 
     	 [bookmark: pgfId-4297343]Understanding the Interface Traffic Widget
 
     	 [bookmark: pgfId-4297347]Understanding the Intrusion Events Widget
 
     	 [bookmark: pgfId-4297351]Understanding the Network Compliance Widget
 
     	 [bookmark: pgfId-4297355]Understanding the Product Licensing Widget
 
     	 [bookmark: pgfId-4297359]Understanding the Product Updates Widget
 
     	 [bookmark: pgfId-4297363]Understanding the RSS Feed Widget
 
     	 [bookmark: pgfId-4297367]Understanding the System Load Widget
 
     	 [bookmark: pgfId-4297371]Understanding the System Time Widget
 
     	 [bookmark: pgfId-4297375]Understanding the White List Events Widget
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-4297376]Note The dashboard widgets you can view depend on the type of appliance you are using and on your user role. For more information, see Understanding Widget Availability.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-4297381][bookmark: 89442]Understanding the Appliance Information Widget
 
     [bookmark: pgfId-4297382]License: Any
 
     [bookmark: pgfId-4297383]The Appliance Information widget provides a snapshot of the appliance. It appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.
 
     [bookmark: pgfId-4388229]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4297388]The widget provides:
 
      
      	 [bookmark: pgfId-4297389]the name, IPv4 address, IPv6 address, and model of the appliance 
 
      	 [bookmark: pgfId-4297393]the versions of the FireSIGHT System software, operating system, Snort, rule update, rule pack, module pack, vulnerability database (VDB), and geolocation update installed on the appliances with dashboards, except for virtual Defense Centers
 
      	 [bookmark: pgfId-4297394]for managed appliances, the name and status of the communications link with the managing appliance
 
      	 [bookmark: pgfId-4297398]for Defense Centers in a high availability pair, the name, model, and FireSIGHT System software and operating system versions of the peer Defense Center, as well as how recently the Defense Centers made contact
 
     
 
     [bookmark: pgfId-4297408]You can configure the widget to display more or less information by modifying the widget preferences to display a simple or an advanced view; the preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4297414][bookmark: 93485]Understanding the Applian[bookmark: marker-4297413]ce Status Widget
 
     [bookmark: pgfId-4297415]License: Any
 
     [bookmark: pgfId-4297416]The Appliance Status widget indicates the health of the appliance and of any appliances it is managing. Note that because the Defense Center does not automatically apply a health policy to managed devices, you must manually apply a health policy to devices or their status appears as Disabled. This widget appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.
 
     [bookmark: pgfId-4388237]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4297429]The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
     [bookmark: pgfId-4297433]You can click a section on the pie chart or one of the numbers on the appliance status table to go to the Health Monitor page and view the compiled health status of the appliance and of any appliances it is managing. For more information, see Using the Health Monitor.
 
    
 
     
      [bookmark: pgfId-4297439][bookmark: 16136]Understanding the [bookmark: marker-4297438]Correlation Events Widget
 
     [bookmark: pgfId-4297443]License: FireSIGHT
 
     [bookmark: pgfId-4297444]The Correlation Events widget shows the average number of correlation events per second, by priority, over the dashboard time range. It appears by default on the Correlation tab of the Detailed Dashboard.
 
     [bookmark: pgfId-4388253]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4297454]Select one or more Priorities check boxes to display separate graphs for events of specific priorities, including events that do not have a priority. Select Show All to display an additional graph for all correlation events, regardless of priority. The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
     [bookmark: pgfId-4297458]You can click a graph to view correlation events of a specific priority, or click the All graph to view all correlation events. In either case, the events are constrained by the dashboard time range; accessing correlation events via the dashboard changes the events (or global) time window for the appliance. For more information on correlation events, see Viewing Correlation Events.
 
    
 
     
      [bookmark: pgfId-4297464][bookmark: 44888]Understanding the Current Inte[bookmark: marker-4297463]rface Status Widget
 
     [bookmark: pgfId-4297465]License: Any
 
     [bookmark: pgfId-4352368]The Current Interface Status widget shows the status of all interfaces on the appliance, enabled or unused. On a Defense Center, you can display the management (eth0, eth1, and so on) interfaces. On a managed device, you can choose to show only sensing (s1p1 and so on) interfaces or both management and sensing interfaces. Interfaces are grouped by type: management, inline, passive, switched, routed, stacked, and unused.
 
      
      	 [bookmark: pgfId-4350788]the name of the interface
 
      	 [bookmark: pgfId-4350789]the link state of the interface
 
      	 [bookmark: pgfId-4350790]the link mode (for example, 100Mb full duplex, or 10Mb half duplex) of the interface
 
      	 [bookmark: pgfId-4355010]the type of interface, that is, copper or fiber
 
      	 [bookmark: pgfId-4355011]the amount of data received (Rx) and transmitted (Tx) by the interface
 
     
 
     [bookmark: pgfId-4355012]The color of the ball representing link state indicates the current status, as follows:
 
      
      	 [bookmark: pgfId-4350814]green: link is up and at full speed
 
      	 [bookmark: pgfId-4350901]yellow: link is up but not at full speed
 
      	 [bookmark: pgfId-4350952]red: link is not up
 
      	 [bookmark: pgfId-4350979]gray: link is administratively disabled
 
      	 [bookmark: pgfId-4351024]blue: link state information is not available (for example, ASA)
 
     
 
     [bookmark: pgfId-4297484]The widget preferences control how often the widget updates. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4297490][bookmark: 62645]Understanding the Cur[bookmark: marker-4297489]rent Sessions Widget
 
     [bookmark: pgfId-4297491]License: Any
 ) and rendered in bold type. Sessions are pruned from this widget’s data within one hour of logoff or inactivity. This widget appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard. 
     
 
     [bookmark: pgfId-4388277]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4297500]On the Current Sessions widget, you can:
 
      
      	 [bookmark: pgfId-4297501]click any user name to manage user accounts on the User Management page; see Managing User Accounts
 
      	 [bookmark: pgfId-4297511]click the host icon (
 
      [image: ] ) or compromised host icon ( 
      [image: ] ) next to any IP address to view the host profile for the associated machine; see 
      Using Host Profiles (Defense Center with network discovery only) 
     
 
      
      	 [bookmark: pgfId-4297518]click any IP address or access time to view the audit log constrained by that IP address and by the time that the user associated with that IP address logged on to the web interface; see Viewing Audit Records
 
     
 
     [bookmark: pgfId-4297522]The widget preferences control how often the widget updates. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4297528][bookmark: 67928]Understanding t[bookmark: marker-4297527]he Custom Analysis Widget
 
     [bookmark: pgfId-4297529]License: Any
 
     [bookmark: pgfId-4297530]The Custom Analysis widget is a highly customizable widget that allows you to display detailed information on the events collected and generated by the FireSIGHT System. 
 
     [bookmark: pgfId-4297534]The Custom Analysis widget is delivered with numerous widget presets, which are groups of configurations that are predefined by Cisco. The presets serve as examples and can provide quick access to information about your deployment. You can use these presets or create a custom configuration.
 
     [bookmark: pgfId-4297538]When you configure the widget preferences, you must select which table and individual field you want to display, as well as the aggregation method that configures how the widget groups the data it displays.
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4322333]The colored bars in the widget background show the relative number of occurrences of each event; you should read the bars from right to left. You can change the color of the bars as well as the number of rows that the widget displays. You can also configure the widget to display the most frequently occurring events or the least frequently occurring events.
 ) indicates and controls the sort order of the display. A downward-pointing icon indicates descending order; an upward-pointing icon indicates ascending order. To change the sort order, click the icon. 
     
 
     [bookmark: pgfId-4297559]Next to each event, the widget can display one of three icons to indicate any changes from the most recent results:
 
      
      	 [bookmark: pgfId-4297563]The new event icon (
 
      [image: ] ) signifies that the event is new to the results. 
     
 
      
      	 [bookmark: pgfId-4297567]The up arrow icon (
 
      [image: ] ) indicates that the event has moved up in the standings since the last time the widget updated. A number indicating how many places the event has moved up appears next to the icon. 
     
 
      
      	 [bookmark: pgfId-4297571]The down arrow icon (
 
      [image: ] ) indicates that the event has moved down in the standings since the last time the widget updated. A number indicating how many places the event has moved down appears next to the icon. 
     
 
     [bookmark: pgfId-4297572]The widget displays the last time it updated, based on the local time of the appliance. The widget updates with a frequency that depends on the dashboard time range. For example, if you set the dashboard time range to an hour, the widget updates every five minutes. On the other hand, if you set the dashboard time range to a year, the widget updates once a week. To determine when the dashboard will update next, hover your pointer over the Last updated notice in the bottom left corner of the widget.
 
     [bookmark: pgfId-4388309]
 
      
      [image: ] 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-4297577]Note If you constrain a Custom Analysis widget using a saved search, then edit the search, the widget does not reflect your changes until the next time it updates.
 
      
      
 
     
 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4297583]Finally, you can choose a custom title for the widget.
 
     [bookmark: pgfId-4297584]From Custom Analysis widgets, you can invoke event views (that is, workflows) that provide detailed information about the events displayed in the widget. To do so, click the event for which you want more information.
 
     [bookmark: pgfId-4297585]You can also right-click any IP address in the custom analysis widget to display a context menu that allows you to obtain more information on the associated host, as well as add it to the global blacklist or whitelist for Security Intelligence filtering.
 
      
       
     
 
     
 
     [bookmark: pgfId-4297586]Note Depending on how you configure them, Custom Analysis widgets may place a drain on an appliance’s resources; a red-shaded Custom Analysis widget indicates that its use is harming system performance. If the widget continues to stay red over time, you should remove the widget.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4297587]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-4297591]Configuring the Custom Analysis Widget
 
      	 [bookmark: pgfId-4297595]Viewing Associated Events from the Custom Analysis Widget
 
      	 [bookmark: pgfId-4297599]Custom Analysis Widget Limitations
 
      	 [bookmark: pgfId-4297603]Using the Context Menu
 
     
 
    
 
     
      [bookmark: pgfId-4297605][bookmark: 65108]Configuring the Custom Analysis Widget
 
     [bookmark: pgfId-4297606]License: Any
 
     [bookmark: pgfId-4297608]Like all widgets, the Custom Analysis [bookmark: marker-4297607]widget has preferences that determine its behavior. To configure a Custom Analysis widget, show the preferences as described in Understanding Widget Preferences. 
 
     [bookmark: pgfId-4297612]A different set of preferences appears depending on whether you configure the widget to show relative occurrences of events (that is, a bar graph), or configure the widget to show a graph over time (that is, a line graph). 
 
     [bookmark: pgfId-4297613]To configure the widget to show a bar graph, select any value except Time from the Field drop-down list.
 
     [bookmark: pgfId-4297614]To configure the widget to show a line graph, select Time from the Field drop-down list.
 
      
       
        
        [bookmark: pgfId-4297621]Table 55-4 Custom Analysis Widget Preferences 
 
        
        
         
         	 
           
           [bookmark: pgfId-4297625]Use this preference... 
          
  
         	 
           
           [bookmark: pgfId-4297627]To control... 
          
  
        
 
         
         	[bookmark: pgfId-4297629]Title
  
         	[bookmark: pgfId-4297631]the title of the widget.
 [bookmark: pgfId-4297632]If you do not specify a title, the appliance uses the configured event type as the widget title.
  
        
 
         
         	[bookmark: pgfId-4297634]Preset
  
         	[bookmark: pgfId-4297636]the preset for the widget.
 [bookmark: pgfId-4297637]The Custom Analysis widget is delivered with numerous presets, which are widget configurations predefined by Cisco. The presets serve as examples and can provide quick access to information about your deployment. You can use these presets or you can create a custom configuration.
 [bookmark: pgfId-4297643]For a detailed list of presets, see the Custom Analysis Widget Presets table.
  
        
 
         
         	[bookmark: pgfId-4297646]Table
  
         	[bookmark: pgfId-4297648]the table of events which contains the event data the widget displays.
  
        
 
         
         	[bookmark: pgfId-4297650]Field
  
         	[bookmark: pgfId-4297652]the specific field of the event type you want to display.
 .  
        
 
         
         	[bookmark: pgfId-4297655]Aggregate
  
         	[bookmark: pgfId-4297657]the aggregation method for the widget.
 [bookmark: pgfId-4297658]The aggregation method configures how the widget groups the data it displays. For most event types, the default aggregation criterion is Count.
  
        
 
         
         	[bookmark: pgfId-4297660]Filter
  
         	[bookmark: pgfId-4297662]a user-defined application filter that you want to use to further constrain the data that the widget displays.
 [bookmark: pgfId-4297663]You can only use application filters if you are displaying data from the Application Statistics or Intrusion Event Statistics by Application tables. For more information on application filters, see Working with Application Filters.
  
        
 
         
         	[bookmark: pgfId-4297668]Search
  
         	[bookmark: pgfId-4297670]the saved search you want to use to further constrain the data that the widget displays.
 [bookmark: pgfId-4297671]You do not have to specify a search, although some presets use predefined searches. 
 [bookmark: pgfId-4297672]If you create a saved connection event search that uses data in fields without an asterisk (*), the widget displays incorrect data. Only fields that constrain connection summaries can constrain custom analysis dashboard widgets based on connection events. Invalid searches are grayed out and cannot be selected.
  
        
 
         
         	[bookmark: pgfId-4297674]Show
  
         	[bookmark: pgfId-4297676]whether you want to display the most frequently occurring events (Top) or the least frequently occurring events (Bottom).
  
        
 
         
         	[bookmark: pgfId-4297678]Results
  
         	[bookmark: pgfId-4297680]the number of result rows you want to display.
 [bookmark: pgfId-4297681]You can display from 10 to 25 result rows, in increments of five.
  
        
 
         
         	[bookmark: pgfId-4297683]Show Movers
  
         	[bookmark: pgfId-4297685]whether you want to display the icons that indicate changes from the most recent results.
  
        
 
         
         	[bookmark: pgfId-4297687]Time Zone
  
         	[bookmark: pgfId-4297689]which time zone you want to use to display results.
 [bookmark: pgfId-4297690]The time zone appears whenever you select a time-based field.
  
        
 
         
         	[bookmark: pgfId-4297692]Color
  
         	[bookmark: pgfId-4297694]the color of the bars in the widget background that show the relative number of occurrences of each result.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4297697]The followi[bookmark: marker-4297696]ng table describes the available presets for the Custom Analysis widget. It also indicates which, if any, Defense Center predefined dashboard uses each preset. Note the following:
 
      
      	 [bookmark: pgfId-4297704]Predefined dashboards on managed devices do not include Custom Analysis widgets. 
 
      	 [bookmark: pgfId-4297714]The DC500 Defense Center does not display and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect data for features they do not support. 
 
     
 
     [bookmark: pgfId-4297723]For more information on specific license types, see Service Subscriptions.
 
     [bookmark: pgfId-4299048].
 
      
       
        
        [bookmark: pgfId-4297731]Table 55-5 [bookmark: 86003]Custom Analysis Widget Presets 
 
        
        
         
         	 
           
           [bookmark: pgfId-4297739]Preset 
          
  
         	 
           
           [bookmark: pgfId-4297741]Description 
          
  
         	 
           
           [bookmark: pgfId-4297743]Predefined Dashboards 
          
  
         	 
           
           [bookmark: pgfId-4297745]Licenses 
          
  
        
 
         
         	[bookmark: pgfId-4297747]All Intrusion Events
  
         	[bookmark: pgfId-4297749]Displays a graph of the total number of intrusion events on your monitored network over the dashboard time range.
  
         	[bookmark: pgfId-4297751]Detailed Dashboard
 [bookmark: pgfId-4297752]Summary Dashboard
  
         	[bookmark: pgfId-4297757]Protection
  
        
 
         
         	[bookmark: pgfId-4297759]All Intrusion Events (Not Dropped)
  
         	[bookmark: pgfId-4297761]Displays the most frequently occurring types of intrusion events, by classification, where the packet was not dropped as part of the event.
  
         	[bookmark: pgfId-4297763]Detailed Dashboard
  
         	[bookmark: pgfId-4297768]Protection
  
        
 
         
         	[bookmark: pgfId-4297770]Allowed Connections by Application
  
         	[bookmark: pgfId-4297772]Displays allowed application connections on your monitored network, grouped by application.
  
         	[bookmark: pgfId-4297774]Application Statistics
  
         	[bookmark: pgfId-4297779]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297781]Allowed Connections by Application Risk
  
         	[bookmark: pgfId-4297783]Displays allowed application connections on your monitored network, grouped by application risk level.
  
         	[bookmark: pgfId-4297785]Application Statistics
  
         	[bookmark: pgfId-4297790]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297792]Allowed Connections by Business Relevance
  
         	[bookmark: pgfId-4297794]Displays allowed application connections on your monitored network, grouped by estimated relevance to business activity.
  
         	[bookmark: pgfId-4297796]Application Statistics
  
         	[bookmark: pgfId-4297801]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297803]Allowed Connections by URL Category
  
         	[bookmark: pgfId-4297805]Displays allowed application connections on your monitored network, grouped by URL category.
  
         	[bookmark: pgfId-4297807]URL Statistics
  
         	[bookmark: pgfId-4297811]URL Filtering
  
        
 
         
         	[bookmark: pgfId-4297814]Allowed Connections by URL Reputation
  
         	[bookmark: pgfId-4297816]Displays allowed application connections on your monitored network, grouped by URL reputation.
  
         	[bookmark: pgfId-4297818]URL Statistics
  
         	[bookmark: pgfId-4297822]URL Filtering
  
        
 
         
         	[bookmark: pgfId-4297825]Allowed Connections by User
  
         	[bookmark: pgfId-4297827]Displays allowed application connections on your monitored network, grouped by connecting user.
  
         	[bookmark: pgfId-4297829]Access Controlled User Statistics
  
         	[bookmark: pgfId-4297834]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297836]Application Protocols Introducing Malware
  
         	[bookmark: pgfId-4297838]Displays the number of malware files transmitted over your network, grouped by the application protocol used to transmit the files.
  
         	[bookmark: pgfId-4297840]Files Dashboard
  
         	[bookmark: pgfId-4297845]Malware
  
        
 
         
         	[bookmark: pgfId-4297847]Application Protocols Transferring Files
  
         	[bookmark: pgfId-4297849]Displays the number of files transmitted over your network, grouped by the application protocol used to transmit the files.
  
         	[bookmark: pgfId-4297851]Files Dashboard
  
         	[bookmark: pgfId-4297856]Protection
  
        
 
         
         	[bookmark: pgfId-4297858]Client Applications Introducing Malware
  
         	[bookmark: pgfId-4297860]Displays the applications, or parent files, that accessed or created malware detected by FireAMP Connectors.
  
         	[bookmark: pgfId-4297865]Files Dashboard
  
         	[bookmark: pgfId-4297870]FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-4297872]Client Applications Transferring Files
  
         	[bookmark: pgfId-4297874]Displays the applications, or parent files, that transmitted files over your network.
  
         	[bookmark: pgfId-4297876]Files Dashboard
  
         	[bookmark: pgfId-4297881]Protection
  
        
 
         
         	[bookmark: pgfId-4297883]Clients
  
         	[bookmark: pgfId-4297885]Displays clients on your monitored network, by type.
  
         	[bookmark: pgfId-4297887]Detailed Dashboard
  
         	[bookmark: pgfId-4297892]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297894]Connections by Application
  
         	[bookmark: pgfId-4297896]Displays applications on your monitored network, based on the number of detected connections.
  
         	[bookmark: pgfId-4297898]Connection Summary
  
         	[bookmark: pgfId-4297903]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297905]Connections by Destination Continent
  
         	[bookmark: pgfId-4297907]Displays continents to which connections were sent from your monitored network, based on the number of connections.
  
         	[bookmark: pgfId-4297909]Connection Summary
  
         	[bookmark: pgfId-4297914]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297916]Connections by Destination Country
  
         	[bookmark: pgfId-4297918]Displays countries to which connections were sent from your monitored network, based on the number of connections.
  
         	[bookmark: pgfId-4297920]Connection Summary
  
         	[bookmark: pgfId-4297925]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297927]Connections by Initiator IP
  
         	[bookmark: pgfId-4297929]Displays host IP addresses on your monitored network, based on the number of connections where that IP address on a host initiated the session.
  
         	[bookmark: pgfId-4297931]Connection Summary
  
         	[bookmark: pgfId-4297936]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297938]Connections by Port
  
         	[bookmark: pgfId-4297940]Displays ports on your monitored network, based on the number of detected connections.
  
         	[bookmark: pgfId-4297942]Connection Summary
  
         	[bookmark: pgfId-4297947]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297949]Connections by Responder IP
  
         	[bookmark: pgfId-4297951]Displays host IP addresses on your monitored network, based on the number of connections where the responder in that session was that IP address on a host. The output of this widget varies according to your connection logging configuration.
  
         	[bookmark: pgfId-4297953]Connection Summary
  
         	[bookmark: pgfId-4297958]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297960]Connections by Security Intelligence Category
  
         	[bookmark: pgfId-4297962]Displays all connections monitored or blocked by Security Intelligence on your monitored network, grouped by Security Intelligence category.
  
         	[bookmark: pgfId-4297964]Summary Dashboard
  
         	[bookmark: pgfId-4297969]Protection
  
        
 
         
         	[bookmark: pgfId-4297971]Connections by Source Continent
  
         	[bookmark: pgfId-4297973]Displays continents communicating with your monitored network, based on the number of connections initiated from each continent.
  
         	[bookmark: pgfId-4297975]Connection Summary
  
         	[bookmark: pgfId-4297980]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297982]Connections by Source Country
  
         	[bookmark: pgfId-4297984]Displays countries communicating with your monitored network, based on the number of connections initiated from each country.
  
         	[bookmark: pgfId-4297986]Connection Summary
  
         	[bookmark: pgfId-4297991]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4297993]Connections by URL Category
  
         	[bookmark: pgfId-4297995]Displays all application connections on your monitored network, grouped by URL category.
  
         	[bookmark: pgfId-4297997]Summary Dashboard
  
         	[bookmark: pgfId-4298001]URL Filtering
  
        
 
         
         	[bookmark: pgfId-4298004]Connections by URL Reputation
  
         	[bookmark: pgfId-4298006]Displays all application connections on your monitored network, grouped by URL reputation.
  
         	[bookmark: pgfId-4298008]Summary Dashboard
  
         	[bookmark: pgfId-4298012]URL Filtering
  
        
 
         
         	[bookmark: pgfId-4298015]Connections over Time
  
         	[bookmark: pgfId-4298017]Displays a graph of the total number of connections on your monitored network, over the dashboard time range.
  
         	[bookmark: pgfId-4298019]Connection Summary
  
         	[bookmark: pgfId-4298024]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298026]Denied Connections by Application
  
         	[bookmark: pgfId-4298028]Displays denied connections on your monitored network, grouped by application.
  
         	[bookmark: pgfId-4298030]Application Statistics
  
         	[bookmark: pgfId-4298035]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298037]Denied Connections by URL Category
  
         	[bookmark: pgfId-4298039]Displays denied connections on your monitored network, grouped by URL category.
  
         	[bookmark: pgfId-4298041]URL Statistics
  
         	[bookmark: pgfId-4298045]URL Filtering
  
        
 
         
         	[bookmark: pgfId-4298048]Denied Connections by URL Reputation
  
         	[bookmark: pgfId-4298050]Displays denied connections on your monitored network, grouped by URL reputation.
  
         	[bookmark: pgfId-4298052]URL Statistics
  
         	[bookmark: pgfId-4298056]URL Filtering
  
        
 
         
         	[bookmark: pgfId-4298059]Denied Connections by User
  
         	[bookmark: pgfId-4298061]Displays denied connections on your monitored network, grouped by connecting user.
  
         	[bookmark: pgfId-4298063]Access Controlled User Statistics
  
         	[bookmark: pgfId-4298068]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298070]Dropped Events by Application
  
         	[bookmark: pgfId-4298072]Displays dropped intrusion events, grouped by application.
  
         	[bookmark: pgfId-4298074]Application Statistics
  
         	[bookmark: pgfId-4298079]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298084]Dropped Events by User
  
         	[bookmark: pgfId-4298086]Displays dropped intrusion events, grouped by user.
  
         	[bookmark: pgfId-4298088]Access Controlled User Statistics
  
         	[bookmark: pgfId-4298093]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298098]Dropped Intrusion Events
  
         	[bookmark: pgfId-4298100]Displays counts for intrusion events, by classification, where the packet was dropped. 
  
         	[bookmark: pgfId-4298102]Detailed Dashboard
 [bookmark: pgfId-4298103]Summary Dashboard
  
         	[bookmark: pgfId-4298108]Protection
  
        
 
         
         	[bookmark: pgfId-4298110]Dynamic Analysis Traffic by Device
  
         	[bookmark: pgfId-4298112]Displays the most active devices, based on the size of the file data submitted to the Collective Security Intelligence Cloud for analysis. 
  
         	[bookmark: pgfId-4298114]Files Dashboard
  
         	[bookmark: pgfId-4298119]Malware
  
        
 
         
         	[bookmark: pgfId-4298121]Dynamic Analysis Traffic over Time
  
         	[bookmark: pgfId-4298123]Displays the captured file data size submitted to the cloud for analysis over the dashboard time range.
  
         	[bookmark: pgfId-4298125]Files Dashboard
  
         	[bookmark: pgfId-4298130]Malware
  
        
 
         
         	[bookmark: pgfId-4298132]File Actions
  
         	[bookmark: pgfId-4298134]Displays the number of files transmitted over your network, grouped by the file rule actions used to handle the files.
  
         	[bookmark: pgfId-4298136]Files Dashboard
  
         	[bookmark: pgfId-4298141]Protection or Malware
  
        
 
         
         	[bookmark: pgfId-4298146]File Categories
  
         	[bookmark: pgfId-4298148]Displays the number of files transmitted over your network, grouped by file category.
  
         	[bookmark: pgfId-4298150]Files Dashboard
  
         	[bookmark: pgfId-4298155]Protection
  
        
 
         
         	[bookmark: pgfId-4298157]File Dispositions
  
         	[bookmark: pgfId-4298159]Displays the number of files detected in network traffic as a result of Malware Cloud Lookup file rules, grouped by malware disposition.
  
         	[bookmark: pgfId-4298161]Files Dashboard
  
         	[bookmark: pgfId-4298166]Malware
  
        
 
         
         	[bookmark: pgfId-4298168]File Names
  
         	[bookmark: pgfId-4298170]Displays the number of files transmitted over your network, grouped by file name.
  
         	[bookmark: pgfId-4298172]Files Dashboard
  
         	[bookmark: pgfId-4298177]Protection
  
        
 
         
         	[bookmark: pgfId-4298179]File Storage by Device
  
         	[bookmark: pgfId-4298181]Displays the devices that have stored the most file data.
  
         	[bookmark: pgfId-4298183]Files Dashboard
  
         	[bookmark: pgfId-4298188]Malware
  
        
 
         
         	[bookmark: pgfId-4298190]File Storage by Disposition
  
         	[bookmark: pgfId-4298192]Displays the size in kilobytes of file data stored on the device, based on file disposition.
  
         	[bookmark: pgfId-4298194]Files Dashboard
  
         	[bookmark: pgfId-4298199]Malware
  
        
 
         
         	[bookmark: pgfId-4298201]File Storage by Type
  
         	[bookmark: pgfId-4298203]Displays the size in kilobytes of file data stored on the device, based on file type.
  
         	[bookmark: pgfId-4298205]Files Dashboard
  
         	[bookmark: pgfId-4298210]Malware
  
        
 
         
         	[bookmark: pgfId-4298212]File Storage over Time
  
         	[bookmark: pgfId-4298214]Displays a graph of kilobytes of file data stored on managed devices over the dashboard time range.
  
         	[bookmark: pgfId-4298216]Files Dashboard
  
         	[bookmark: pgfId-4298221]Malware
  
        
 
         
         	[bookmark: pgfId-4298223]File Transfers over Time
  
         	[bookmark: pgfId-4298225]Displays a graph of the total number of file transfers detected in network traffic by the system, over the dashboard time range.
  
         	[bookmark: pgfId-4298227]Files Dashboard
  
         	[bookmark: pgfId-4298232]Protection
  
        
 
         
         	[bookmark: pgfId-4298234]File Types
  
         	[bookmark: pgfId-4298236]Displays the number of files transmitted over your network, grouped by file type.
  
         	[bookmark: pgfId-4298238]Files Dashboard
  
         	[bookmark: pgfId-4298243]Protection
  
        
 
         
         	[bookmark: pgfId-4298245]File Types Infected with Malware
  
         	[bookmark: pgfId-4298247]Displays the number of malware detected either in network traffic by the system or by FireAMP Connectors, grouped by file type.
  
         	[bookmark: pgfId-4298252]Files Dashboard
  
         	[bookmark: pgfId-4298257]Malware
  
        
 
         
         	[bookmark: pgfId-4298259]Files Sent for Dynamic Analysis over Time
  
         	[bookmark: pgfId-4298261]Displays a graph of the total number of files submitted for dynamic analysis, over the dashboard time range.
  
         	[bookmark: pgfId-4298263]Files Dashboard
  
         	[bookmark: pgfId-4298268]Malware
  
        
 
         
         	[bookmark: pgfId-4298270]Files Stored over Time
  
         	[bookmark: pgfId-4298272]Displays a graph of the total number of files stored on managed devices, over the dashboard time range.
  
         	[bookmark: pgfId-4298274]Files Dashboard 
  
         	[bookmark: pgfId-4298279]Malware
  
        
 
         
         	[bookmark: pgfId-4298281]Hosts Receiving Files
  
         	[bookmark: pgfId-4298283]Displays the number of files received (downloaded) by host IP addresses on your network, grouped by IP address.
  
         	[bookmark: pgfId-4298285]Files Dashboard
  
         	[bookmark: pgfId-4298290]Protection
  
        
 
         
         	[bookmark: pgfId-4298292]Hosts Receiving Malware
  
         	[bookmark: pgfId-4298294]Displays the number of malware files received by host IP addresses on your network, grouped by IP address.
  
         	[bookmark: pgfId-4298296]Files Dashboard
  
         	[bookmark: pgfId-4298301]Malware license or FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-4298306]Hosts Sending Files
  
         	[bookmark: pgfId-4298308]Displays the number of files sent (uploaded) from host IP addresses on your network, grouped by IP address.
  
         	[bookmark: pgfId-4298310]Files Dashboard
  
         	[bookmark: pgfId-4298315]Protection
  
        
 
         
         	[bookmark: pgfId-4298317]Hosts Sending Malware
  
         	[bookmark: pgfId-4298319]Displays the number of malware files sent from host IP addresses on your network, grouped by IP address.
  
         	[bookmark: pgfId-4298321]Files Dashboard
  
         	[bookmark: pgfId-4298326]Malware
  
        
 
         
         	[bookmark: pgfId-4298328]Impact X Events by Application
  
         	[bookmark: pgfId-4298330]Displays number of events of estimated impact level X (where X is a number 0-4), grouped by application.
  
         	[bookmark: pgfId-4298332]Application Statistics
  
         	[bookmark: pgfId-4298337]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298342]Impact Level X Events by Application Protocol
  
         	[bookmark: pgfId-4298344]Displays number of events of estimated impact level X (where X is a number 1-2), grouped by application protocol.
  
         	[bookmark: pgfId-4298346]Summary Dashboard
  
         	[bookmark: pgfId-4298351]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298356]Impact Level X Events by User
  
         	[bookmark: pgfId-4298358]Displays number of events of estimated impact level X (where X is a number 0-4), grouped by user.
  
         	[bookmark: pgfId-4298360]Access Controlled User Statistics
  
         	[bookmark: pgfId-4298365]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298370]Indications of Compromise by Host
  
         	[bookmark: pgfId-4298372]Displays number of triggered indications of compromise, grouped by associated host IP address.
  
         	[bookmark: pgfId-4298374]Summary Dashboard
  
         	[bookmark: pgfId-4298379]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298381]Intrusion Events Requiring Analysis
  
         	[bookmark: pgfId-4298383]Displays a count of intrusion events requiring analysis, based on event classification.
  
         	[bookmark: pgfId-4298385]Detailed Dashboard
  
         	[bookmark: pgfId-4298390]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298395]Intrusion Events by Destination Continent
  
         	[bookmark: pgfId-4298397]Displays continents targeted by intrusion events, based on the number of events associated with each continent.
  
         	[bookmark: pgfId-4298399]Summary Dashboard
  
         	[bookmark: pgfId-4298404]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298406]Intrusion Events by Destination Country
  
         	[bookmark: pgfId-4298408]Displays countries targeted by intrusion events, based on the number of events associated with each country.
  
         	[bookmark: pgfId-4298410]Summary Dashboard
  
         	[bookmark: pgfId-4298415]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298417]Intrusion Events by Source Continent
  
         	[bookmark: pgfId-4298419]Displays continents where intrusion events originated, based on the number of events originated from each continent.
  
         	[bookmark: pgfId-4298421]Summary Dashboard
  
         	[bookmark: pgfId-4298426]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298428]Intrusion Events by Source Country
  
         	[bookmark: pgfId-4298430]Displays countries where intrusion events originated, based on the number of events originated from each country.
  
         	[bookmark: pgfId-4298432]Summary Dashboard
  
         	[bookmark: pgfId-4298437]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298439]Intrusion Events to High Criticality Hosts
  
         	[bookmark: pgfId-4298441]Displays intrusion events, based on the number of intrusion events occurring on high criticality hosts.
  
         	[bookmark: pgfId-4298443]Detailed Dashboard
  
         	[bookmark: pgfId-4298448]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298453]Malware Intrusions
  
         	[bookmark: pgfId-4298455]Displays intrusion events, based on the number of intrusion events occurring in connections transmitting malware.
  
         	[bookmark: pgfId-4298457]Files Dashboard
  
         	[bookmark: pgfId-4298462]Malware
  
        
 
         
         	[bookmark: pgfId-4298464]Malware Threats
  
         	[bookmark: pgfId-4298466]Displays the number of malware threats detected either in network traffic by the system or by FireAMP Connectors, grouped by threat name.
  
         	[bookmark: pgfId-4298471]Files Dashboard
  
         	[bookmark: pgfId-4298476]Malware license or FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-4298481]New Indications of Compromise over Time
  
         	[bookmark: pgfId-4298483]Displays a graph of new indications of compromise detected over the dashboard time range.
  
         	[bookmark: pgfId-4298485]Summary Dashboard
  
         	[bookmark: pgfId-4298490]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298492]Operating Systems
  
         	[bookmark: pgfId-4298494]Displays operating systems, based on the number of hosts running each operating system within your network.
  
         	[bookmark: pgfId-4298496]Detailed Dashboard
  
         	[bookmark: pgfId-4298501]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298503]Possible Zero-Day Malware
  
         	[bookmark: pgfId-4298505]Displays the captured files most likely to be zero-day malware, with a file disposition of unknown and either High or Very High threat scores, based on the number of times the file was seen.
  
         	[bookmark: pgfId-4298507]Files Dashboard
  
         	[bookmark: pgfId-4298512]Malware
  
        
 
         
         	[bookmark: pgfId-4298514]Processes Introducing Malware
  
         	[bookmark: pgfId-4298516]Displays the system processes that accessed or created malware detected by FireAMP Connectors.
  
         	[bookmark: pgfId-4298521]Files Dashboard
  
         	[bookmark: pgfId-4298526]Malware license or FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-4298531]Risky Applications with Low Business Relevance
  
         	[bookmark: pgfId-4298533]Displays all application connections on your monitored network that have both high application risk level and low estimated business relevance.
  
         	[bookmark: pgfId-4298535]Summary Dashboard
  
         	[bookmark: pgfId-4298540]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298542]Servers
  
         	[bookmark: pgfId-4298544]Displays servers, by number of hosts.
  
         	[bookmark: pgfId-4298546]Detailed Dashboard
  
         	[bookmark: pgfId-4298551]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298553]SSL Actions
  
         	[bookmark: pgfId-4298555]Displays a count of the SSL rule actions taken on encrypted traffic, based on frequency. 
  
         	[bookmark: pgfId-4298557]Connection Summary
  
         	[bookmark: pgfId-4298562]Any
  
        
 
         
         	[bookmark: pgfId-4298564]SSL Certificate Status
  
         	[bookmark: pgfId-4298566]Displays a count of the certificate statuses the system detected in SSL-encrypted sessions, based on frequency. 
  
         	[bookmark: pgfId-4298568]Connection Summary
  
         	[bookmark: pgfId-4298573]Any
  
        
 
         
         	[bookmark: pgfId-4298575]SSL Decryption Failure Reasons
  
         	[bookmark: pgfId-4298577]Displays a count of the system’s reasons to improperly decrypt SSL-encrypted sessions, based on frequency.
  
         	[bookmark: pgfId-4298579]Connection Summary
  
         	[bookmark: pgfId-4298584]Any
  
        
 
         
         	[bookmark: pgfId-4298586]SSL Sessions Decrypted over Time
  
         	[bookmark: pgfId-4298588]Displays a graph of the number of SSL-encrypted sessions the system decrypted, over the dashboard time range.
  
         	[bookmark: pgfId-4298590]Connection Summary
  
         	[bookmark: pgfId-4298595]Any
  
        
 
         
         	[bookmark: pgfId-4298597]SSL Sessions Not Decrypted over Time
  
         	[bookmark: pgfId-4298599]Displays a graph of the number of SSL-encrypted sessions the system did not decrypt, over the dashboard time range.
  
         	[bookmark: pgfId-4298601]Connection Summary
  
         	[bookmark: pgfId-4298606]Any
  
        
 
         
         	[bookmark: pgfId-4298608]SSL Sessions with Errors over Time
  
         	[bookmark: pgfId-4298610]Displays a graph of the number of SSL-encrypted sessions the system detected that contained internal errors, over the dashboard time range. 
  
         	[bookmark: pgfId-4298612]Connection Summary
  
         	[bookmark: pgfId-4298617]Any
  
        
 
         
         	[bookmark: pgfId-4298619]Threat Detections over Time
  
         	[bookmark: pgfId-4298621]Displays a graph of the total number of malware threats detected either in network traffic by the system or by FireAMP Connectors, over the dashboard time range.
  
         	[bookmark: pgfId-4298626]Files Dashboard
  
         	[bookmark: pgfId-4298631]Malware license or FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-4298636]Top Attackers
  
         	[bookmark: pgfId-4298638]Displays attacking host IP addresses on your monitored network, based on the number of intrusion events where the listed IP address was the attacker in the connection that caused the event.
  
         	[bookmark: pgfId-4298640]Summary Dashboard
  
         	[bookmark: pgfId-4298645]Protection
  
        
 
         
         	[bookmark: pgfId-4298647]Top Client Applications Seen
  
         	[bookmark: pgfId-4298649]Displays client applications on your monitored network, based on total kilobytes of data transmitted by the client application.
  
         	[bookmark: pgfId-4298651]Summary Dashboard
  
         	[bookmark: pgfId-4298656]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298658]Top Operating Systems Seen
  
         	[bookmark: pgfId-4298660]Displays operating systems on your monitored network, based on the number of network hosts with the operating system.
  
         	[bookmark: pgfId-4298662]Summary Dashboard
  
         	[bookmark: pgfId-4298667]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298669]Top Server Applications Seen
  
         	[bookmark: pgfId-4298671]Displays server applications on your monitored network, based on the number of hosts running the service.
  
         	[bookmark: pgfId-4298673]Summary Dashboard
  
         	[bookmark: pgfId-4298678]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298680]Top Targets
  
         	[bookmark: pgfId-4298682]Displays host IP addresses on your monitored network, based on the number of intrusion events where that address was targeted in the connection that caused the event.
  
         	[bookmark: pgfId-4298684]Summary Dashboard
  
         	[bookmark: pgfId-4298689]Protection
  
        
 
         
         	[bookmark: pgfId-4298691]Top Threats
  
         	[bookmark: pgfId-4298693]Displays the distribution of threat scores, based on the number of stored files with that threat score. 
  
         	[bookmark: pgfId-4298695]Files Dashboard
  
         	[bookmark: pgfId-4298700]Malware
  
        
 
         
         	[bookmark: pgfId-4298702]Top Web Applications Seen
  
         	[bookmark: pgfId-4298704]Displays web applications on your monitored network, based on total kilobytes of data transmitted by the client application.
  
         	[bookmark: pgfId-4298706]Summary Dashboard
  
         	[bookmark: pgfId-4298711]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298713]Total Events by Application
  
         	[bookmark: pgfId-4298715]Displays applications on your monitored network, based on the number of intrusion events generated by the application.
  
         	[bookmark: pgfId-4298717]Application Statistics
  
         	[bookmark: pgfId-4298722]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298727]Total Events by Application Protocol
  
         	[bookmark: pgfId-4298729]Displays application protocols on your monitored network, based on the number of intrusion events associated with the application protocol.
  
         	[bookmark: pgfId-4298731]Summary Dashboard
  
         	[bookmark: pgfId-4298736]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298741]Total Events by User
  
         	[bookmark: pgfId-4298743]Displays users on your monitored network, based on the number of intrusion events generated by each user’s activity.
  
         	[bookmark: pgfId-4298745]Summary Dashboard
 [bookmark: pgfId-4298746]Access Controlled User Statistics
  
         	[bookmark: pgfId-4298751]Protection + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298756]Traffic by Application
  
         	[bookmark: pgfId-4298758]Displays applications on your monitored network, based on total kilobytes of data transmitted on your monitored network by the application over the dashboard time range.
  
         	[bookmark: pgfId-4298760]Application Statistics
 [bookmark: pgfId-4298761]Connection Summary
 [bookmark: pgfId-4298762]Detailed Dashboard
  
         	[bookmark: pgfId-4298767]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298769]Traffic by Application Category
  
         	[bookmark: pgfId-4298771]Displays application categories on your monitored network, based on total kilobytes of data transmitted on your monitored network by applications in each category over the dashboard time range.
  
         	[bookmark: pgfId-4298773]Application Statistics
 [bookmark: pgfId-4298774]Summary Dashboard
  
         	[bookmark: pgfId-4298779]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298781]Traffic by Application Risk
  
         	[bookmark: pgfId-4298783]Displays estimated risk levels of applications on your monitored network, based on total kilobytes of data transmitted on your monitored network by applications at each level over the dashboard time range.
  
         	[bookmark: pgfId-4298785]Summary Dashboard
  
         	[bookmark: pgfId-4298790]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298792]Traffic by Business Relevance
  
         	[bookmark: pgfId-4298794]Displays estimated business relevance levels of applications on your monitored network, based on total kilobytes of data transmitted on your monitored network by applications at each level over the dashboard time range.
  
         	[bookmark: pgfId-4298796]Summary Dashboard
  
         	[bookmark: pgfId-4298801]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298803]Traffic by Destination Continent
  
         	[bookmark: pgfId-4298805]Displays continents contacted from your monitored network, based on total kilobytes of data transmitted on your monitored network to each continent over the dashboard time range.
  
         	[bookmark: pgfId-4298807]Connection Summary
  
         	[bookmark: pgfId-4298812]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298814]Traffic by Destination Country
  
         	[bookmark: pgfId-4298816]Displays countries contacted from your monitored network, based on total kilobytes of data transmitted on your monitored network to each country over the dashboard time range.
  
         	[bookmark: pgfId-4298818]Connection Summary
  
         	[bookmark: pgfId-4298823]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298825]Traffic by Initiator IP
  
         	[bookmark: pgfId-4298827]Displays host IP addresses on your monitored network, based on total kilobytes of data transmitted on your monitored network from the IP address over the dashboard time range.
  
         	[bookmark: pgfId-4298829]Connection Summary
 [bookmark: pgfId-4298830]Detailed Dashboard
  
         	[bookmark: pgfId-4298835]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298837]Traffic by Initiator User
  
         	[bookmark: pgfId-4298839]Displays users on your monitored network, based on total kilobytes of data received by the hosts where those users are logged in.
  
         	[bookmark: pgfId-4298841]Detailed Dashboard
 [bookmark: pgfId-4298842]Summary Dashboard
  
         	[bookmark: pgfId-4298847]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298849]Traffic by Port
  
         	[bookmark: pgfId-4298851]Displays responder ports on your monitored network, based on total kilobytes of data transmitted on your monitored network via each port over the dashboard time range. The output of this widget varies according to your connection logging configuration.
  
         	[bookmark: pgfId-4298853]Connection Summary
  
         	[bookmark: pgfId-4298858]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298860]Traffic by Responder IP
  
         	[bookmark: pgfId-4298862]Displays IP addresses on your monitored network, based on total kilobytes of data received by the IP addresses (on hosts) over the dashboard time range. The output of this widget varies according to your connection logging configuration.
  
         	[bookmark: pgfId-4298864]Connection Summary
 [bookmark: pgfId-4298865]Detailed Dashboard
  
         	[bookmark: pgfId-4298870]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298872]Traffic by Security Intelligence Category
  
         	[bookmark: pgfId-4298874]Displays Security Intelligence categories on your monitored network, based on total kilobytes of data transmitted over connections in each category over the dashboard time range.
  
         	[bookmark: pgfId-4298876]Summary Dashboard
  
         	[bookmark: pgfId-4298881]Protection
  
        
 
         
         	[bookmark: pgfId-4298883]Traffic by Source Continent
  
         	[bookmark: pgfId-4298885]Displays continents transmitting data to your monitored network, based on total kilobytes of data on your monitored network transmitted from each continent over the dashboard time range.
  
         	[bookmark: pgfId-4298887]Connection Summary
  
         	[bookmark: pgfId-4298892]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298894]Traffic by Source Country
  
         	[bookmark: pgfId-4298896]Displays countries transmitting data to your monitored network, based on total kilobytes of data on your monitored network transmitted from each country over the dashboard time range.
  
         	[bookmark: pgfId-4298898]Connection Summary
  
         	[bookmark: pgfId-4298903]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298905]Traffic by URL Category
  
         	[bookmark: pgfId-4298907]Displays application URL categories on your monitored network, based on total kilobytes of data exchanged with URLs of each category over the dashboard time range.
  
         	[bookmark: pgfId-4298909]URL Statistics
  
         	[bookmark: pgfId-4298913]URL Filtering
  
        
 
         
         	[bookmark: pgfId-4298916]Traffic by URL Reputation
  
         	[bookmark: pgfId-4298918]Displays application URL reputation types on your monitored network, based on total kilobytes of data exchanged with URLs of each reputation over the dashboard time range.
  
         	[bookmark: pgfId-4298920]URL Statistics
  
         	[bookmark: pgfId-4298924]URL Filtering
  
        
 
         
         	[bookmark: pgfId-4298927]Traffic by User
  
         	[bookmark: pgfId-4298929]Displays users on your monitored network, based on total kilobytes of data exchanged by each user over the dashboard time range.
  
         	[bookmark: pgfId-4298931]None
  
         	[bookmark: pgfId-4298936]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298938]Traffic over Time
  
         	[bookmark: pgfId-4298940]Displays a graph of total kilobytes of data transmitted on your monitored network over the dashboard time range.
  
         	[bookmark: pgfId-4298942]Connection Summary
 [bookmark: pgfId-4298943]Detailed Dashboard
  
         	[bookmark: pgfId-4298948]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298950]Unique Applications over Time
  
         	[bookmark: pgfId-4298952]Displays a graph of total unique applications detected on your monitored network over the dashboard time range.
  
         	[bookmark: pgfId-4298954]Application Statistics
 [bookmark: pgfId-4298955]Summary Dashboard
  
         	[bookmark: pgfId-4298960]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298962]Unique Users over Time
  
         	[bookmark: pgfId-4298964]Displays a graph of total unique users detected on your monitored network over the dashboard time range.
  
         	[bookmark: pgfId-4298966]Access Controlled User Statistics
  
         	[bookmark: pgfId-4298971]FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4298973]Users Affected by Malware
  
         	[bookmark: pgfId-4298975]Displays the number of threats detected either in network traffic by the system or by FireAMP Connectors, grouped by user.
  
         	[bookmark: pgfId-4298980]Files Dashboard
  
         	[bookmark: pgfId-4298985]Malware + FireSIGHT, or FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-4298993]Users Transferring Files
  
         	[bookmark: pgfId-4298995]Displays the number of files being transmitted over your network, grouped by sender.
  
         	[bookmark: pgfId-4298997]Files Dashboard
  
         	[bookmark: pgfId-4299002]Malware + FireSIGHT
  
        
 
         
         	[bookmark: pgfId-4299007]Web Applications Introducing Malware
  
         	[bookmark: pgfId-4299009]Displays web applications on your monitored network that accessed or created malware detected by FireAMP Connectors.
  
         	[bookmark: pgfId-4299014]Files Dashboard
  
         	[bookmark: pgfId-4299019]Malware license or FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-4299024]Web Applications Transferring Files
  
         	[bookmark: pgfId-4299026]Displays the number of files transmitted over your network, grouped by the web application used to transmit the files.
  
         	[bookmark: pgfId-4299028]Files Dashboard
  
         	[bookmark: pgfId-4299033]Malware license or FireAMP subscription
  
        
 
         
         	[bookmark: pgfId-4299038]White List Violations
  
         	[bookmark: pgfId-4299040]Displays hosts with white list violations, by violation count.
  
         	[bookmark: pgfId-4299042]Detailed Dashboard
  
         	[bookmark: pgfId-4299047]FireSIGHT
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-4299050][bookmark: 28318]Viewing Associated Events from the Custom Analysis Widget
 
     [bookmark: pgfId-4299051]License: Any
 
     [bookmark: pgfId-4299052]Depending on the kind of data that a Custom Analysis widget is configured to display, you can invoke an event view (that is, a workflow) that provides detailed information about the events displayed in the widget.
 
     [bookmark: pgfId-4299053]When you invoke an event view from the dashboard, the events appear in the default workflow for that event type, constrained by the dashboard time range. This also changes the appropriate time window for the appliance, depending on how many time windows you have configured and on what type of event you are trying to view.
 
     [bookmark: pgfId-4299056]For example, if you configure multiple time windows on your Defense Center and then access health events from a Custom Analysis widget, the events appear in the default health events workflow, and the health monitoring time window changes to the dashboard time range.
 
     [bookmark: pgfId-4299058]As another example, if you configure a single time window and then access any type of event from the Custom Analysis widget, the events appear in the default workflow for that event type, and the global time window changes to the dashboard time range.
 
     [bookmark: pgfId-4299062]For more information on time windows, see Default Time Windows and Specifying Time Constraints in Searches.
 
     [bookmark: pgfId-4299066]To view associated events from the Custom Analysis Widget:
 
     [bookmark: pgfId-4299067]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299068]Step 1 You have two options, depending on how you configured the widget:
 
      
       
       	 [bookmark: pgfId-4299069]On widgets configured to show relative occurrences of events (that is, bar graphs), click any event to view associated events constrained by the widget preferences, as well as by that event. You can also click the view all icon (
 
      
 
      [image: ] ) in the lower right corner of the widget to view all associated events, constrained by the widget preferences. 
     
 
      
       
       	 [bookmark: pgfId-4299073]On widgets configured to show connection data over time, click the view all icon in the lower right corner of the widget to view all associated events, constrained by the widget preferences.
 
      
 
     
 
     [bookmark: pgfId-4299074]For information on working with specific event types, see the following sections:
 
      
       
       	 [bookmark: pgfId-4299078]Working with Security Intelligence Lists and Feeds
 
       	 [bookmark: pgfId-4299082]Viewing Audit Records
 
       	 [bookmark: pgfId-4299086]Viewing Intrusion Events
 
       	 [bookmark: pgfId-4299090]Viewing Discovery and Host Input Events
 
       	 [bookmark: pgfId-4299094]Viewing File Events
 
       	 [bookmark: pgfId-4299098]Viewing Malware Events
 
       	 [bookmark: pgfId-4299102]Viewing Captured Files
 
       	 [bookmark: pgfId-4299106]Viewing Hosts
 
       	 [bookmark: pgfId-4299110]Viewing Host Attributes
 
       	 [bookmark: pgfId-4299114]Viewing Indications of Compromise
 
       	 [bookmark: pgfId-4299118]Viewing Servers
 
       	 [bookmark: pgfId-4299122]Viewing Application Details
 
       	 [bookmark: pgfId-4299126]Viewing Vulnerabilities
 
       	 [bookmark: pgfId-4299130]Viewing Third-Party Vulnerabilities
 
       	 [bookmark: pgfId-4299134]Viewing Connection and Security Intelligence Data
 
       	 [bookmark: pgfId-4299138]Viewing Users
 
       	 [bookmark: pgfId-4299142]Viewing User Activity Events
 
       	 [bookmark: pgfId-4299146]Viewing Correlation Events
 
       	 [bookmark: pgfId-4299150]Viewing White List Events
 
       	 [bookmark: pgfId-4299154]Viewing White List Violations
 
       	 [bookmark: pgfId-4299158]Viewing Health Events
 
       	 [bookmark: pgfId-4299162]Viewing the Rule Update Log
 
       	 [bookmark: pgfId-4299166]Working with Active Scan Results
 
       	 [bookmark: pgfId-4299170]Using Geolocation
 
       	 [bookmark: pgfId-4299174]Understanding Custom Tables
 
      
 
     
 
    
 
     
      [bookmark: pgfId-4299176][bookmark: 66239]Custom Analysis Widget Limitations
 
     [bookmark: pgfId-4299177]License: Any
 
     [bookmark: pgfId-4299178]There are some important points to keep in mind when using the Custom Analysis widget.
 
     [bookmark: pgfId-4299179]If you are configuring the widget on a shared dashboard, remember that not all users can view data of all event types, depending on the user’s account privileges. For example, Maintenance Users cannot view discovery events. 
 
     [bookmark: pgfId-4299180]Similarly, if you are using a dashboard imported from another appliance, remember that not all appliances have access to data of all event types. For example, managed devices do not store correlation data. If your dashboard includes a Custom Analysis widget that displays data you cannot see, the widget indicates that you are unauthorized to view the data. Note, however, that you (and any other users who share the dashboard) can modify the preferences of the widget to display data that you can see, or even delete the widget. If you want to make sure that this does not happen, save the dashboard as private.
 
     [bookmark: pgfId-4299181]Remember that only you can access searches that you have saved as private. If you configure the widget on a shared dashboard and constrain its events using a private search, the widget resets to not using the search when another user logs in. This affects your view of the widget as well. If you want to make sure that this does not happen, save the dashboard as private.
 
     [bookmark: pgfId-4299182]You enable or disable the Custom Analysis widget from the Dashboard settings in your system policy. For more information, see Configuring Dashboard Settings.
 
    
 
     
      [bookmark: pgfId-4299188][bookmark: 73429]Understanding the D[bookmark: marker-4299187]isk Usage Widget
 
     [bookmark: pgfId-4299189]License: Any
 
      
      [image: ] 
     
 
      
       
        
        [bookmark: pgfId-4299204]Table 55-6 Disk Usage Categories 
 
        
        
         
         	 
           
           [bookmark: pgfId-4299208]Disk Usage Category 
          
  
         	 
           
           [bookmark: pgfId-4299210]Description 
          
  
        
 
         
         	[bookmark: pgfId-4299212]Events
  
         	[bookmark: pgfId-4299214]all events logged by the system
  
        
 
         
         	[bookmark: pgfId-4299216]Files
  
         	[bookmark: pgfId-4299218]all files stored by the system
  
        
 
         
         	[bookmark: pgfId-4299220]Backups
  
         	[bookmark: pgfId-4299222]all backup files
  
        
 
         
         	[bookmark: pgfId-4299224]Updates
  
         	[bookmark: pgfId-4299226]all files related to updates, such as rule updates and system updates
  
        
 
         
         	[bookmark: pgfId-4299228]Other
  
         	[bookmark: pgfId-4299230]system troubleshooting files and other miscellaneous files
  
        
 
         
         	[bookmark: pgfId-4299232]Free
  
         	[bookmark: pgfId-4299234]free space remaining on the appliance
  
        
 
        
      
 
     
 
     [bookmark: pgfId-4299236]You can hover your pointer over a disk usage category in the By Category stacked bar to view the percentage of available disk space used by that category, the actual storage space on the disk, and the total disk space available for that category. Note that if you have a malware storage pack installed, the total disk space available for the Files category is the available disk space on the malware storage pack. For more information, see Understanding Captured File Storage.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299245]The widget preferences also control how often the widget updates, as well as whether it displays the current disk usage or collected disk usage statistics over the dashboard time range. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4299252][bookmark: 36366][bookmark: 89582]Understanding the Inte[bookmark: marker-4299251]rface Traffic Widget
 
     [bookmark: pgfId-4299253]License: Any
 
     [bookmark: pgfId-4375383]The Interface Traffic widget shows the rate of traffic received (Rx) and transmitted (Tx) on the appliance’s management (eth0 and so on) and sensing (s1p1 and so on) interfaces over the dashboard time range. It does not appear by default on any of the predefined dashboards.
 
     [bookmark: pgfId-4375384]Outbound (transmitted) traffic includes flow control packets. Because of this, passive interfaces on your appliances may show transmitted traffic and generate events; this is expected behavior. Note also that devices with Malware licenses enabled periodically attempt to connect to the Cisco cloud even if you have not configured dynamic analysis. Because of this, these devices show transmitted traffic; this is also expected behavior.
 
     [bookmark: pgfId-4388341]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4367255]The widget preferences control how often the widget updates. On managed devices, the preferences also control whether the widget displays the traffic rate for unused interfaces (by default, the widget only displays the traffic rate for active interfaces). For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4299265][bookmark: 42004]Understanding the Int[bookmark: marker-4299264]rusion Events Widget
 
     [bookmark: pgfId-4299269]License: Protection
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299275]On managed devices, the widget can display statistics for dropped (or, on passively deployed devices, would have dropped) intrusion events, all intrusion events, or both. Note that you must enable local event storage or the widget will not have any data to display. Note also that the total rate represented by All does not include the dropped event rate.
 
     [bookmark: pgfId-4299282]On the Defense Center, but not managed devices, you can configure the widget to display intrusion events with dropped/would have dropped packets and different impacts by modifying the widget preferences. You can display dropped and would have dropped events on Defense Centers and devices. The following graphic shows the Defense Center version of the widget preferences.
 
     [bookmark: pgfId-4388357]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299296]In the widget preferences, you can:
 
      
      	 [bookmark: pgfId-4299303]on a Defense Center,select one or more  Event Flags  check boxes to display separate graphs for events with dropped packets, would have dropped packets, or specific impacts; select  All  to display an additional graph for all intrusion events, regardless of impact or rule state; see Using Impact Levels to Evaluate Events for more information
 
      	 [bookmark: pgfId-4299307]select  Show  to choose  Average Events Per Second or  Total Events 
 
      	 [bookmark: pgfId-4299308]select  Vertical Scale to choose  Linear (incremental) or  Logarithmic (factor of ten) scale
 
     
 
     [bookmark: pgfId-4299309]The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
     [bookmark: pgfId-4299313]On the Intrusion Events widget, you can:
 
      
      	 [bookmark: pgfId-4299320]on a Defense Center, click a graph corresponding to dropped packets, to would have dropped packets, or to a specific impact to view intrusion events of that type
 
      	 [bookmark: pgfId-4299321]click the graph corresponding to dropped events to view dropped events
 
      	 [bookmark: pgfId-4299322]click the graph corresponding to would have dropped events to view would have dropped events
 
      	 [bookmark: pgfId-4299323]click the  All graph to view all intrusion events
 
     
 
     [bookmark: pgfId-4299324]Note that the resulting event view is constrained by the dashboard time range; accessing intrusion events via the dashboard changes the events (or global) time window for the appliance. For more information on intrusion events, see Viewing Intrusion Events.
 
     [bookmark: pgfId-4299328]Note also that packets in a passive deployment are not dropped, regardless of the rule state or the inline drop behavior of the intrusion policy.
 
    
 
     
      [bookmark: pgfId-4299337][bookmark: 98019]Understanding the Network Compl[bookmark: marker-4299336]iance Widget
 
     [bookmark: pgfId-4299341]License: FireSIGHT
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299355]If you choose to display network compliance for all white lists, the widget considers a host to be non-compliant if it is not compliant with any white list in an active correlation policy.
 
     [bookmark: pgfId-4299356]You can also use the widget preferences to specify which of three different styles you want to use to display network compliance. 
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299375]The preferences control how often the widget updates. You can check the Show Not Evaluated box to hide events which have not been evaluated. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4299381][bookmark: 72517]Understanding the Prod[bookmark: marker-4299380]uct Licensing Widget
 
     [bookmark: pgfId-4299382]License: Any
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299391]The top section of the widget displays all device and feature licenses installed on the Defense Center, including temporary licenses, while the Expiring Licenses section displays only temporary and expired licenses. For example, if you have two feature licenses for FireSIGHT Hosts, one of which is a permanent license and allows 750 hosts, and another that is temporary and allows an additional 750 hosts, the top section of the widget displays a FireSIGHT Hosts feature license with 1500 licensed hosts, while the Expiring Licenses section displays a FireSIGHT Hosts feature license with 750 hosts.
 
     [bookmark: pgfId-4299404]The bars in the widget background show the percentage of each type of license that is being used; you should read the bars from right to left. Expired licenses are marked with a strikethrough. 
 
     [bookmark: pgfId-4299405]You can configure the widget to display either the features that are currently licensed, or all the features that you can license, by modifying the widget preferences. The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
     [bookmark: pgfId-4299409]You can click any of the license types to go to the License page of the local configuration and add or delete feature licenses. For more information, see Licensing the FireSIGHT System.
 
    
 
     
      [bookmark: pgfId-4299415][bookmark: 16968]Understanding the Product U[bookmark: marker-4299414]pdates Widget
 
     [bookmark: pgfId-4299416]License: Any
 
     [bookmark: pgfId-4299417]The Product Updates widget provides you with a summary of the software (FireSIGHT System software and rule updates) currently installed on the appliance as well as information on available updates that you have downloaded, but not yet installed, for that software. This widget appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.
 
     [bookmark: pgfId-4299421]Note that the widget displays Unknown as the latest version of the software unless you have configured a scheduled task to download, push, or install software updates; the widget uses scheduled tasks to determine the latest version. For more information, see Scheduling Tasks.
 
     [bookmark: pgfId-4299425]The widget also provides you with links to pages where you can update the software; the Defense Center version of the widget provides you with similar links so you can update the software on your managed devices.
 
     [bookmark: pgfId-4388413]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299433]You can configure the widget to hide the latest versions by modifying the widget preferences. The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
     [bookmark: pgfId-4299437]On the Product Updates widget, you can:
 
      
      	 [bookmark: pgfId-4299438]manually update an appliance by clicking the current version of the FireSIGHT System software, rule update, geolocation update, or VDB:
 
       
       	 [bookmark: pgfId-4299442]to update the system software, geolocation database, or VDB, see Updating System Software.
 
       	 [bookmark: pgfId-4299448]to import the newest rule update, see Importing Rule Updates and Local Rule Files.
 
      
 
      	 [bookmark: pgfId-4299452]create a scheduled task to download the latest version of the FireSIGHT System software, rule update, or VDB by clicking either the latest version or the  Unknown link in the Latest column; see Scheduling Tasks.
 
     
 
    
 
     
      [bookmark: pgfId-4299459][bookmark: 78210]Understanding the R[bookmark: marker-4299458]SS Feed Widget
 
     [bookmark: pgfId-4299460]License: Any
 
     [bookmark: pgfId-4299461]The RSS Feed widget adds an RSS feed to a dashboard. By default, the widget shows a feed of Cisco security news. It appears by default on the Status tabs of the Detailed Dashboard and the Summary Dashboard.
 
     [bookmark: pgfId-4388421]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299477]Feeds update every 24 hours (although you can manually update the feed), and the widget displays the last time the feed was updated based on the local time of the appliance. Keep in mind that the appliance must have access to the web site (for the two preconfigured feeds) or to any custom feed you configure.
 
     [bookmark: pgfId-4299481]When you configure the widget, you can also choose how many stories from the feed you want to show in the widget, as well as whether you want to show descriptions of the stories along with the headlines; keep in mind that not all RSS feeds use descriptions.
 
     [bookmark: pgfId-4299482]On the RSS Feed widget, you can:
 
      
      	 [bookmark: pgfId-4299483]click one of the stories in the feed to view the story
 
      	 [bookmark: pgfId-4299484]click the  more link to go to the feed’s web site
 
      	 [bookmark: pgfId-4299488]click the update icon (
 
      [image: ] ) to manually update the feed 
     
 
    
 
     
      [bookmark: pgfId-4299491][bookmark: 63658]Understanding the Sys[bookmark: marker-4299490]tem Load Widget
 
     [bookmark: pgfId-4299492]License: Any
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299498]You can configure the widget to show or hide the load average by modifying the widget preferences. The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4299504][bookmark: 95948]Understanding the Syst[bookmark: marker-4299503]em Time Widget
 
     [bookmark: pgfId-4299505]License: Any
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299511]You can configure the widget to hide the boot time by modifying the widget preferences. The preferences also control how often the widget synchronizes with the appliance’s clock. For more information, see Understanding Widget Preferences.
 
    
 
     
      [bookmark: pgfId-4299517][bookmark: 10571]Understanding the Wh[bookmark: marker-4299516]ite List Events Widget
 
     [bookmark: pgfId-4299521]License: FireSIGHT
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-4299532]In the widget preferences, you can:
 
      
      	 [bookmark: pgfId-4299533]select one or more  Priorities check boxes to display separate graphs for events of specific priorities, including events that do not have a priority 
 
      	 [bookmark: pgfId-4299534]select  Show All to display an additional graph for all white list events, regardless of priority 
 
      	 [bookmark: pgfId-4299535]select  Vertical Scale to choose  Linear (incremental) or  Logarithmic (factor of ten) scale 
 
     
 
     [bookmark: pgfId-4299536]The preferences also control how often the widget updates. For more information, see Understanding Widget Preferences.
 
     [bookmark: pgfId-4299540]You can click a graph to view white list events of a specific priority, or click the All graph to view all white list events. In either case, the events are constrained by the dashboard time range; accessing white list events via the dashboard changes the events (or global) time window for the Defense Center. For more information on white list events, see Viewing White List Events.
 
    
 
   
 
    
     [bookmark: pgfId-4299550][bookmark: 65839]Working with Dashbo[bookmark: marker-4299549]ards
 
    [bookmark: pgfId-4299552]License: Any
 
    [bookmark: pgfId-4299553]You can view and modify the widgets that appear on the dashboard. 
 
    [bookmark: pgfId-4299556]You manage dashboards on the Dashboard Management page (see Viewing Dashboards). You can create, view, modify, export, and delete dashboards.
 
    [bookmark: pgfId-4299558]For each dashboard, the page indicates the owner (that is, the user who created it) and whether a dashboard is private. Note that, unless you have Administrator access, you can only see your own private dashboards; you cannot view or modify private dashboards created by other users. 
 
    [bookmark: pgfId-4299559]Finally, the page indicates which dashboard is the default. You specify the default dashboard in your user preferences; for more information, see Specifying Your Default Dashboard.
 
    [bookmark: pgfId-4299563]For more information on working with dashboards, see:
 
     
     	 [bookmark: pgfId-4299567]Creating a Custom Dashboard
 
     	 [bookmark: pgfId-4299571]Viewing Dashboards
 
     	 [bookmark: pgfId-4299575]Modifying Dashboards
 
     	 [bookmark: pgfId-4299579]Deleting a Dashboard
 
     	 [bookmark: pgfId-4299583]Exporting Configurations
 
    
 
     
      [bookmark: pgfId-4299587][bookmark: 42964]Creating a Custo[bookmark: marker-4299585]m Dashboard
 
     [bookmark: pgfId-4299589]License: Any
 
     [bookmark: pgfId-4299590]When you create a new dashboard, you can choose to base it on any existing dashboard, whether user-created or predefined by Cisco. This makes a copy of the preexisting dashboard; you can modify this copy to suit your needs. Optionally, you can create a blank new dashboard by choosing not to base your dashboard on any preexisting dashboards.
 
     [bookmark: pgfId-4299594]You must also specify (or disable) the tab change and page refresh intervals. These settings determine how often the dashboard cycles through its tabs and how often the entire dashboard page refreshes.
 
     [bookmark: pgfId-4299595]Refreshing the entire dashboard allows you to see any preference or layout changes that were made to a shared dashboard by another user, or that you made to a private dashboard on another computer, since the last time the dashboard refreshed. This may be useful, for example, in a network operations center (NOC) where a dashboard is displayed at all times. If you want to make changes to the dashboard, you can make the changes at a local computer. Then, the dashboard in the NOC automatically refreshes at the interval you specify and displays your changes without you having to manually refresh the dashboard in the NOC. Note that you do not need to refresh the entire dashboard to see data updates; individual widgets update according to their preferences.
 
     [bookmark: pgfId-4299596]Finally, you can choose to associate the new dashboard with your user account by saving it as a private dashboard. If you choose not to save the dashboard as private, all other users of the appliance can view it.
 
     [bookmark: pgfId-4299597]Keep in mind that because not all user roles have access to all dashboard widgets, users with fewer permissions viewing a dashboard created by a user with more permissions may not be able to use all of the widgets on the dashboard. Although the unauthorized widgets still appear on the dashboard, they are disabled.
 
     [bookmark: pgfId-4299598]You should also keep in mind that any user with dashboard access, regardless of role, can modify shared dashboards. If you want to make sure that only you can modify a particular dashboard, save it as private.
 
      
       
     
 
     
 
     [bookmark: pgfId-4299599]Tip Instead of creating a new dashboard, you can export a dashboard from another appliance, then import it onto your appliance. You can then edit the imported dashboard to suit your needs. Note that the dashboard widgets you can view depend on the type of appliance you are using and on your user role; for example, a dashboard created on the Defense Center and imported onto a managed device may display some invalid, disabled widgets. For more information, see Importing and Exporting Configurations.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299609]To create a new dashboard:
 
     [bookmark: pgfId-4299610]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299611]Step 1 Select Overview > Dashboards > Management.
 
     [bookmark: pgfId-4299612]The Dashboard Management page appears.
 
     [bookmark: pgfId-4299613]Step 2 Click Create Dashboard.
 
     [bookmark: pgfId-4299614]The Create Dashboard page appears.
 
     [bookmark: pgfId-4299615]Step 3 Use the Copy Dashboard drop-down list to select the dashboard on which you want to base the new dashboard.
 
     [bookmark: pgfId-4299616]You can select any predefined or user-defined dashboard. Optionally, select None (the default) to create a blank dashboard.
 
     [bookmark: pgfId-4299617]Step 4 Type a name and optional description for the dashboard.
 
     [bookmark: pgfId-4299618]Step 5 In the Change Tabs Every field, specify (in minutes) how often the dashboard should change tabs.
 
     [bookmark: pgfId-4299619]Unless you pause the dashboard or your dashboard has only one tab, this setting advances your view to the next tab at the interval you specify. To disable tab cycling, enter 0 in the Change Tabs Every field.
 
     [bookmark: pgfId-4299620]Step 6 In the Refresh Page Every field, specify (in minutes) how often the current dashboard tab should refresh with new data. This value must be greater than the Change Tabs Every setting.
 
     [bookmark: pgfId-4299621]Unless you pause the dashboard, this setting will refresh the entire dashboard at the interval you specify. To disable the periodic page refresh, enter 0 in the Refresh Page Every field.
 
     [bookmark: pgfId-4299622]Note that this setting is separate from the update interval available on many individual widgets; although refreshing the dashboard page resets the update interval on individual widgets, widgets will update according to their individual preferences even if you disable the Refresh Page Every setting.
 
     [bookmark: pgfId-4299623]Step 7 Optionally, select the Save As Private check box to associate the dashboard with your user account and to prevent other users from viewing and modifying the dashboard.
 
     [bookmark: pgfId-4299624]Step 8 Click Save.
 
     [bookmark: pgfId-4299625]Your dashboard is created and appears in the web interface. You can now tailor it to suit your needs by adding tabs and widgets (and, if you based it on a preexisting dashboard, by rearranging and deleting widgets). For more information, see Modifying Dashboards.
 
     [bookmark: pgfId-4331308]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299631][bookmark: 77774]Viewing Dashb[bookmark: marker-4299630]oards
 
     [bookmark: pgfId-4299632]License: Any
 
     [bookmark: pgfId-4299633]By default, the home page for your appliance displays the default dashboard. If you do not have a default dashboard defined, the home page shows the Dashboard Management page, where you can choose a dashboard to view. At any time, to view the default dashboard you have configured for your appliance, select Overview > Dashboards; to view details of all available dashboards, select Overview > Dashboards > Management.
 
      
       
     
 
     
 
     [bookmark: pgfId-4299634]Tip You can configure your appliance to display a different default home page, including pages that are not dashboard pages. You can also change the default dashboard. For more information, see Specifying Your Home Page and Specifying Your Default Dashboard.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299641]Each dashboard has a time range that constrains its widgets. You can change the time range to reflect a period as short as the last hour (the default) or as long as the last year. When you change the time range, the widgets that can be constrained by time automatically update to reflect the new time range. 
 
     [bookmark: pgfId-4299642]Note that not all widgets can be constrained by time. For example, the dashboard time range has no effect on the Appliance Information widget, which provides information that includes the appliance name, model, and current version of the FireSIGHT System software.
 
     [bookmark: pgfId-4299649]Keep in mind that for enterprise deployments of the FireSIGHT System, changing the time range to a long period may not be useful for widgets like the Custom Analysis widget, depending on how often newer events replace older events.
 
     [bookmark: pgfId-4299650]You can also pause a dashboard, which allows you to examine the data provided by the widgets without the display changing and interrupting your analysis. Pausing a dashboard has the following effects:
 
      
      	 [bookmark: pgfId-4299651]Individual widgets stop updating, regardless of any  Update Every widget preference.
 
      	 [bookmark: pgfId-4299652]Dashboard tabs stop cycling, regardless of the  Cycle Tabs Every setting in the dashboard properties.
 
      	 [bookmark: pgfId-4299653]Dashboard pages stop refreshing, regardless of the  Refresh Page Every setting in the dashboard properties.
 
      	 [bookmark: pgfId-4299654]Changing the time range has no effect.
 
     
 
     [bookmark: pgfId-4299655]When you are finished with your analysis, you can unpause the dashboard. Unpausing the dashboard causes all appropriate widgets on the page to update to reflect the current time range. In addition, dashboard tabs resume cycling and the dashboard page resumes refreshing according to the settings you specified in the dashboard properties.
 
     [bookmark: pgfId-4299656]If you experience connectivity problems or other issues that interrupt the flow of system information to the dashboard, the dashboard automatically pauses and an error notice appears until the problem is resolved.
 
      
       
     
 
     
 
     [bookmark: pgfId-4299657]Note Your session normally logs you out after 1 hour of inactivity (or another configured interval), regardless of whether the dashboard is paused. If you plan to passively monitor the dashboard for long periods of time, consider exempting some users from session timeout, or changing the system timeout settings. For more information, see Managing User Login Settings and Configuring User Interface Settings.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299664]To view a dashboard:
 
     [bookmark: pgfId-4299665]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299666]Step 1 Select Overview > Dashboards. You have two options, depending on whether you have a default dashboard defined:
 
      
       
       	 [bookmark: pgfId-4299667]If you have a default dashboard defined, it appears. To view a different dashboard, use the  Overview > Dashboards  menu.
 
       	 [bookmark: pgfId-4299668]If you do not have a default dashboard defined, the Dashboard Management page appears. Click  View next to the dashboard you want to view.
 
      
 
     
 
     [bookmark: pgfId-4299669]The dashboard you selected appears.
 
     [bookmark: pgfId-4331328]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299670]To change the dashboard time range:
 
     [bookmark: pgfId-4299671]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299672]Step 1 From the Show the Last drop-down list, choose a dashboard time range.
 
     [bookmark: pgfId-4299673]Unless the dashboard is paused, all appropriate widgets on the page update to reflect the new time range.
 
     [bookmark: pgfId-4331362]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299674]To pause the dashboard:
 
     [bookmark: pgfId-4299675]Access: Admin/Any Security Analyst/Maint
 
     
 ). 
     
 
     [bookmark: pgfId-4299680]The dashboard is paused until you unpause it.
 
     [bookmark: pgfId-4331376]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299681]To unpause the dashboard:
 
     [bookmark: pgfId-4299682]Access: Admin/Any Security Analyst/Maint
 
     
 ). 
     
 
     [bookmark: pgfId-4299687]The dashboard is unpaused.
 
     [bookmark: pgfId-4331405]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299690][bookmark: 94090]Modifying Dashboar[bookmark: marker-4299689]ds
 
     [bookmark: pgfId-4299691]License: Any
 
     [bookmark: pgfId-4299692]A dashboard has one or more tabs. You can add, delete, and rename tabs. Note that you cannot change the order of dashboard tabs.
 
     [bookmark: pgfId-4299693]Each tab can display one or more widgets in a three-column layout. You can minimize and maximize widgets, add and remove widgets from tabs, as well as rearrange the widgets on a tab.
 
     [bookmark: pgfId-4299694]You can also change the basic dashboard properties, which include its name and description, the tab cycle and page refresh intervals, and whether you want to share the dashboard with other users.
 
     [bookmark: pgfId-4299695]Note that any user with dashboard access, regardless of role, can modify shared dashboards. If you want to make sure that only you can modify a particular dashboard, make sure to set it as a private dashboard in the dashboard properties.
 
     [bookmark: pgfId-4299699]Every configuration of the Custom Analysis widget in the Cisco predefined dashboards corresponds to a preset for that widget. If you change or delete one of these widgets, you can restore it by creating a new Custom Analysis widget based on the appropriate preset. For more information, see
 
      
       
     
 
     
 
     [bookmark: pgfId-4299703]Tip Every configuration of the Custom Analysis widget in the Cisco predefined dashboards corresponds to a system preset for that widget. If you change or delete one of these widgets, you can restore it by creating a new Custom Analysis widget based on the appropriate preset. For more information, see Configuring the Custom Analysis Widget.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299708]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-4299712]Changing Dashboard Properties
 
      	 [bookmark: pgfId-4299716]Adding Tabs
 
      	 [bookmark: pgfId-4299720]Deleting Tabs
 
      	 [bookmark: pgfId-4299724]Renaming Tabs
 
      	 [bookmark: pgfId-4299728]Adding Widgets
 
      	 [bookmark: pgfId-4299732]Rearranging Widgets
 
      	 [bookmark: pgfId-4299736]Minimizing and Maximizing Widgets
 
      	 [bookmark: pgfId-4299740]Deleting Widgets
 
     
 
    
 
     
      [bookmark: pgfId-4299743][bookmark: 79309]Changing Dash[bookmark: marker-4299742]board Properties
 
     [bookmark: pgfId-4299744]License: Any
 
     [bookmark: pgfId-4299745]Use the following procedure to change the basic dashboard properties, which include its name and description, the tab cycle and page refresh intervals, and whether you want to share the dashboard with other users. 
 
     [bookmark: pgfId-4299746]To change a dashboard’s properties:
 
     [bookmark: pgfId-4299747]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299748]Step 1 Select Overview > Dashboards > Management.
 
     [bookmark: pgfId-4299749]The Dashboard Management page appears.
 ) next to the dashboard whose properties you want to change. 
     
 
     [bookmark: pgfId-4299756]The Edit Dashboard page appears. See Creating a Custom Dashboard for information on the various configurations you can change.
 
     [bookmark: pgfId-4299758]Step 3 Make changes as needed and click Save.
 
     [bookmark: pgfId-4299759]The dashboard is changed.
 
     [bookmark: pgfId-4331429]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299762][bookmark: 88329]Adding Ta[bookmark: marker-4299761]bs
 
     [bookmark: pgfId-4299763]License: Any
 
     [bookmark: pgfId-4299764]Use the following procedure to add a tab to a dashboard.
 
     [bookmark: pgfId-4299765]To add a tab to a dashboard:
 
     [bookmark: pgfId-4299766]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299767]Step 1 View the dashboard where you want to add a tab.
 
     [bookmark: pgfId-4299771]For more information, see Viewing Dashboards.
 ). 
     
 
     [bookmark: pgfId-4299776]A pop-up window appears, prompting you to name the tab.
 
     [bookmark: pgfId-4299777]Step 3 Type a name for the tab (maximum 25 characters) and click OK, or simply click OK to accept the default name. Note that you can rename the tab at any time; see Renaming Tabs.
 
     [bookmark: pgfId-4299781]The new tab is added. You can now add widgets to the new tab. For more information, see Adding Widgets.
 
     [bookmark: pgfId-4331445]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299787][bookmark: 58006]Deleting Ta[bookmark: marker-4299786]bs
 
     [bookmark: pgfId-4299788]License: Any
 
     [bookmark: pgfId-4299789]Use the following procedure to delete a dashboard tab and all its widgets. You cannot delete the last tab from a dashboard; each dashboard must have at least one tab.
 
     [bookmark: pgfId-4299790]To delete a tab from a dashboard:
 
     [bookmark: pgfId-4299791]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299792]Step 1 View the dashboard where you want to delete a tab.
 
     [bookmark: pgfId-4299796]For more information, see Viewing Dashboards.
 ). 
     
 
     [bookmark: pgfId-4299801]Step 3 Confirm that you want to delete the tab.
 
     [bookmark: pgfId-4299802]The tab is deleted.
 
     [bookmark: pgfId-4331462]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299805][bookmark: 81473]Renam[bookmark: marker-4299804]ing Tabs
 
     [bookmark: pgfId-4299806]License: Any
 
     [bookmark: pgfId-4299807]Use the following procedure to rename a dashboard tab.
 
     [bookmark: pgfId-4299808]To rename a tab:
 
     [bookmark: pgfId-4299809]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299810]Step 1 View the dashboard where you want to rename a tab.
 
     [bookmark: pgfId-4299814]For more information, see Viewing Dashboards.
 
     [bookmark: pgfId-4299815]Step 2 Click the tab you want to rename.
 
     [bookmark: pgfId-4299816]Step 3 Click the tab title.
 
     [bookmark: pgfId-4299817]A pop-up window appears, prompting you to rename the tab.
 
     [bookmark: pgfId-4299818]Step 4 Type a name for the tab (maximum 25 characters) and click OK.
 
     [bookmark: pgfId-4299819]The tab is renamed.
 
     [bookmark: pgfId-4331482]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299823][bookmark: 38373]Addi[bookmark: marker-4299821]ng Widgets
 
     [bookmark: pgfId-4299825]License: Any
 
     [bookmark: pgfId-4299826]To add a widget to a dashboard, you must first decide to which tab you want to add the widget. When you add a widget to a tab, the appliance automatically adds it to the column with the fewest widgets. If all columns have an equal number of widgets, the new widget is added to the leftmost column. You can add a maximum of 15 widgets to a dashboard tab.
 
      
       
     
 
     
 
     [bookmark: pgfId-4299827]Tip After you add widgets, you can move them to any location on the tab. You cannot, however, move widgets from tab to tab. For more information, see Rearranging Widgets.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299831]To add a widget to a dashboard:
 
     [bookmark: pgfId-4299832]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299833]Step 1 View the dashboard where you want to add a widget.
 
     [bookmark: pgfId-4299837]For more information, see Viewing Dashboards.
 
     [bookmark: pgfId-4299838]Step 2 Select the tab where you want to add the widget.
 
     [bookmark: pgfId-4299839]Step 3 Click Add Widgets.
 
     [bookmark: pgfId-4299840]The Add Widgets page appears.
 
     [bookmark: pgfId-4299841]The widgets that you can add depend on the type of appliance you are using and on your user role. They are organized according to function: Analysis & Reporting, Miscellaneous, and Operations. You can view the widgets in each category by clicking on the category name, or you can view all widgets by clicking All Categories.
 
     [bookmark: pgfId-4299842]Step 4 Click Add next to the widgets you want to add. 
 
      
       
     
 
     
 
     [bookmark: pgfId-4299843]Tip To add multiple widgets of the same type (for example, you may want to add multiple RSS Feed widgets, or multiple Custom Analysis widgets), click Add again.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299844]The widget is immediately added to the dashboard. The Add Widgets page indicates how many widgets of each type are on the tab, including the widget you just added.
 
     [bookmark: pgfId-4299845]Step 5 Optionally, when you are finished adding widgets, click Done to return to the dashboard.
 
     [bookmark: pgfId-4299846]The tab where you added the widgets appears again, reflecting the changes you made.
 
     [bookmark: pgfId-4331502]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299849][bookmark: 36396]Rearranging Widg[bookmark: marker-4299848]ets
 
     [bookmark: pgfId-4299850]License: Any
 
     [bookmark: pgfId-4299851]You can change the location of any widget on a tab. Note, however, that you cannot move widgets from tab to tab. If you want a widget to appear on a different tab, you must delete it from the existing tab and add it to the new tab.
 
     [bookmark: pgfId-4299852]To move a widget:
 
     [bookmark: pgfId-4299853]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299854]Step 1 Click the title bar of the widget you want to move, then drag it to its new location.
 
     [bookmark: pgfId-4331518]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299857][bookmark: 94334]Minimizing and Max[bookmark: marker-4299856]imizing Widgets
 
     [bookmark: pgfId-4299858]License: Any
 
     [bookmark: pgfId-4299859]You can minimize widgets to simplify your view, then maximize them when you want to see them again.
 
     [bookmark: pgfId-4299860]To minimize a widget:
 
     [bookmark: pgfId-4299861]Access: Admin/Any Security Analyst/Maint
 
     
 ) in a widget’s title bar. 
     
 
     [bookmark: pgfId-4331534]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4299866]To maximize a widget:
 
     [bookmark: pgfId-4299867]Access: Admin/Any Security Analyst/Maint
 
     
 ) in a minimized widget’s title bar. 
     
 
     [bookmark: pgfId-4331550]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299874][bookmark: 32508]Deleting Wid[bookmark: marker-4299873]gets
 
     [bookmark: pgfId-4299875]License: Any
 
     [bookmark: pgfId-4299876]Delete a widget if you no longer want to view it on a tab.
 
     [bookmark: pgfId-4299877]To delete a widget:
 
     [bookmark: pgfId-4299878]Access: Admin/Any Security Analyst/Maint
 
     
 ) in the title bar of the widget. 
     
 
     [bookmark: pgfId-4299883]Step 2 Confirm that you want to delete the widget.
 
     [bookmark: pgfId-4299884]The widget is deleted from the tab.
 
     [bookmark: pgfId-4331562]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4299887][bookmark: 20181]Deleting a Dashb[bookmark: marker-4299886]oard
 
     [bookmark: pgfId-4299888]License: Any
 
     [bookmark: pgfId-4299889]Delete a dashboard if you no longer need to use it.
 
     [bookmark: pgfId-4299890]If you delete your default dashboard, you must define a new default or the appliance will force you to select a dashboard to view every time you attempt to view a dashboard. For more information, see Specifying Your Default Dashboard.
 
     [bookmark: pgfId-4299894]To delete a dashboard:
 
     [bookmark: pgfId-4299895]Access: Admin/Any Security Analyst/Maint
 
     
 
     [bookmark: pgfId-4299896]Step 1 Select Overview > Dashboards > Management.
 
     [bookmark: pgfId-4299897]The Dashboard Management page appears.
 ) next to the dashboard you want to delete. 
     
 
     [bookmark: pgfId-4299903]Step 3 Confirm that you want to delete the dashboard.
 
     [bookmark: pgfId-4299904]The dashboard is deleted.
 
     [bookmark: pgfId-4331574]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2766149]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1520513][bookmark: 94594]Using th[bookmark: marker-1574242]e Context Explorer 
      
      
 
     
 
 
    [bookmark: pgfId-1580467]The FireSIGHT System Context Explorer displays detailed, interactive graphical information in context about the status of your monitored network, including data on applications, application statistics, connections, geolocation, indications of compromise, intrusion events, hosts, servers, Security Intelligence, users, files (including malware files), and relevant URLs. Distinct sections present this data in the form of vivid line, bar, pie, and donut graphs, accompanied by detailed lists. 
 
    [bookmark: pgfId-1576951]You can easily create and apply custom filters to fine-tune your analysis, and you can examine data sections in more detail by simply clicking or hovering your cursor over graph areas. You can also configure the explorer’s time range to reflect a period as short as the last hour or as long as the last year. Only users with the Administrator, Security Analyst, or Security Analyst (Read Only) user roles have access to the Context Explorer.
 
    [bookmark: pgfId-1522666]The FireSIGHT System dashboard is highly customizable and compartmentalized and updates in real time. In contrast, the Context Explorer is manually updated, designed to provide broader context for its data, and has a single, consistent layout designed for active user exploration. 
 
    [bookmark: pgfId-1579924]You use the dashboard to monitor real-time activity on your network and appliances according to your own specific needs. Conversely, you use the Context Explorer to investigate a predefined set of recent FireSIGHT data in granular detail and clear context: for example, if you notice that only 15% of hosts on your network use Linux, but account for almost all YouTube traffic, you can quickly apply filters to view data only for Linux hosts, only for YouTube-associated application data, or both. Unlike the compact, narrowly focused dashboard widgets, the Context Explorer sections are designed to provide striking visual representations of system activity in a format useful to both expert and casual users of the FireSIGHT System.
 
    [bookmark: pgfId-1719613]Note that the data displayed depends on such factors as how you license and deploy your managed devices, whether you configure features that provide the data and, in the case of Series 2 appliances and Cisco NGIPS for Blue Coat X-Series, whether the appliance supports a feature that provides the data. For example, neither the DC500 Defense Center nor Series 2 devices or Cisco NGIPS for Blue Coat X-Series support advanced malware protection, so the DC500 Defense Center cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. 
 
    [bookmark: pgfId-1719639]The following table [bookmark: marker-1719638]summarizes some of the key differences between the dashboard and the Context Explorer.
 
    [bookmark: pgfId-1524071]
 
     
      
       
       [bookmark: pgfId-1524285]Table 56-1 [bookmark: 67173]Comparison: Dashboard and Context Explorer 
 
       
       
        
        	 
          
          [bookmark: pgfId-1524291]Feature 
         
  
        	 
          
          [bookmark: pgfId-1524293]Dashboard 
         
  
        	 
          
          [bookmark: pgfId-1524298]Context Explorer 
         
  
       
 
        
        	[bookmark: pgfId-1524300]Displayable data
  
        	[bookmark: pgfId-1524302]Anything monitored by the FireSIGHT System
  
        	[bookmark: pgfId-1524304]Applications, application statistics, geolocation, indications of compromise, intrusion events, files (including malware files), hosts, Security Intelligence events, servers, users, and URLs
  
       
 
        
        	[bookmark: pgfId-1525067]Customizability
  
        	 
          
          	 [bookmark: pgfId-1525069]Selection of widgets for a dashboard is customizable
 
          	 [bookmark: pgfId-1525319]Individual widgets can be customized to varying degrees
 
         
  
        	 
          
          	 [bookmark: pgfId-1525071]Cannot change base layout
 
          	 [bookmark: pgfId-1525217]Applied filters appear in explorer URL and can be bookmarked for later use
 
         
  
       
 
        
        	[bookmark: pgfId-1524306]Data update frequency
  
        	[bookmark: pgfId-1524308]Automatic (default); user-configured
  
        	[bookmark: pgfId-1524560]Manual
  
       
 
        
        	[bookmark: pgfId-1524668]Data filtering
  
        	[bookmark: pgfId-1524670]Possible for some widgets (must edit widget preferences)
  
        	[bookmark: pgfId-1524672]Possible for all parts of the explorer, with support for multiple filters
  
       
 
        
        	[bookmark: pgfId-1525397]Graphical context
  
        	[bookmark: pgfId-1525399]Some widgets (particularly Custom Analysis) can display data in graph form
  
        	[bookmark: pgfId-1525401]Extensive graphical context for all data, including uniquely detailed donut graphs
  
       
 
        
        	[bookmark: pgfId-1525709]Links to relevant web interface pages
  
        	[bookmark: pgfId-1525711]In some widgets
  
        	[bookmark: pgfId-1525713]In every section
  
       
 
        
        	[bookmark: pgfId-1524312]Time range of displayed data
  
        	[bookmark: pgfId-1524314]User-configured
  
        	[bookmark: pgfId-1524316]User-configured
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1590392]For more information on the related FireSIGHT System dashboard, see Using Dashboards.
 
   
 
    
     [bookmark: pgfId-1590398]Understa[bookmark: marker-1590394]nding the Context Explorer
 
    [bookmark: pgfId-1590530]License: FireSIGHT
 
    [bookmark: pgfId-1521042]The Context Explorer comprises several distinct sections that together offer a complete overview of FireSIGHT data on your monitored network. The first section, a line chart of traffic and event counts over time, provides an at-a-glance picture of recent trends in your network’s activity. 
 
    [bookmark: pgfId-1597070]The other sections are sets of interactive graphs and lists that provide greater detail for indications of compromise, network, application, Security Intelligence, intrusion, file, geolocation, and URL data. Except for the traffic and events time graph, you can view or hide any section. You can also apply filters to constrain the data that appears in all sections; see Working with Filters in the Context Explorer for more information.
 
    [bookmark: pgfId-1527187]For in-depth information on the content and function of Context Explorer sections, see the following topics:
 
     
     	 [bookmark: pgfId-1527323]Understanding the Traffic and Intrusion Event Counts Time Graph
 
     	 [bookmark: pgfId-1642943]Understanding the Indications of Compromise Section
 
     	 [bookmark: pgfId-1527344]Understanding the Network Information Section
 
     	 [bookmark: pgfId-1527353]Understanding the Application Information Section
 
     	 [bookmark: pgfId-1643022]Understanding the Security Intelligence Section
 
     	 [bookmark: pgfId-1527359]Understanding the Intrusion Information Section
 
     	 [bookmark: pgfId-1593597]Understanding the Files Information Section
 
     	 [bookmark: pgfId-1613992]Understanding the Geolocation Information Section
 
     	 [bookmark: pgfId-1527365]Understanding the URL Information Section
 
    
 
    [bookmark: pgfId-1548078]For information on how to configure the Context Explorer as a whole, see the following topics:
 
     
     	 [bookmark: pgfId-1548481]Refreshing the Context Explorer
 
     	 [bookmark: pgfId-1548672]Setting the Context Explorer Time Range
 
     	 [bookmark: pgfId-1548678]Minimizing and Maximizing Context Explorer Sections
 
     	 [bookmark: pgfId-1548684]Drilling Down on Context Explorer Data
 
    
 
    [bookmark: pgfId-1572175]For information on configuring and using Context Explorer filters, see the following topics:
 
     
     	 [bookmark: pgfId-1572274]Working with Filters in the Context Explorer
 
     	 [bookmark: pgfId-1572290]Adding and Applying Filters
 
     	 [bookmark: pgfId-1572299]Creating Filters with the Context Menu
 
     	 [bookmark: pgfId-1589703]Bookmarking Filters
 
    
 
     
      [bookmark: pgfId-1589708][bookmark: 36251]Understa[bookmark: marker-1589705]nding the Traffic and Intru[bookmark: marker-1589707]sion Event Counts Time Graph
 
     [bookmark: pgfId-1589712]License: FireSIGHT
 
     [bookmark: pgfId-1527384]At the top of the Context Explorer is a line chart of traffic and intrusion events over time. The X-axis plots time intervals (which range from five minutes to one month, depending on the selected time window). The Y-axis plots traffic in kilobytes (blue line) and intrusion event count (red line).
 
     [bookmark: pgfId-1638962]Note that the smallest X-axis interval is five minutes. To accommodate this, the system will round the beginning and ending points in your selected time range down to the nearest five-minute interval.
 
     [bookmark: pgfId-1730862]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1590780]By default, this section shows all network traffic and all generated intrusion events for the selected time range. If you apply filters, the chart changes to display only traffic and intrusion events associated with the criteria specified in the filters. For example, filtering on the OS Name of Windows causes the time graph to display only traffic and events associated with hosts using Windows operating systems.
 
     [bookmark: pgfId-1529034]If you filter the Context Explorer on intrusion event data (such as a Priority of High), the blue Traffic line is hidden to allow greater focus on intrusion events alone.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1575297]This section draws data primarily from the Intrusion Events and Connection Events tables.
 
    
 
     
      [bookmark: pgfId-1647393][bookmark: 32761]Understandi[bookmark: marker-1653512]ng the Indicatio[bookmark: marker-1653060]ns of Compromise Section
 
     [bookmark: pgfId-1647549]License: FireSIGHT
 
     [bookmark: pgfId-1647657]The Indications of Compromise (IOC) section of the Context Explorer contains two interactive sections that provide an overall picture of potentially compromised hosts on your monitored network: a proportional view of the most prevalent IOC types triggered, as well as a view of hosts by number of triggered indications.
 
     [bookmark: pgfId-1648403]For more information on the graphs in the Indications of Compromise section, see the following topics:
 
      
      	 [bookmark: pgfId-1648557]Viewing the Hosts by Indication Graph
 
      	 [bookmark: pgfId-1648583]Viewing the Indications by Host Graph
 
     
 
    
 
     
      [bookmark: pgfId-1648609][bookmark: 77695]Viewing the Hosts by Indication Graph
 
     [bookmark: pgfId-1648774]License: FireSIGHT
 
     [bookmark: pgfId-1648802]The Hosts by Indication graph, in donut form, displays a proportional view of the Indications of Compromise (IOC) triggered by hosts on your monitored network. The inner ring divides by IOC category (such as CnC Connected or Malware Detected), while the outer ring further divides that data by specific event type (such as Impact 2 Intrusion Event — attempted-admin or Threat Detected in File Transfer).
 
     [bookmark: pgfId-1730878]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1648655]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1650065]This graph draws data primarily from the Hosts and Indications of Compromise tables.
 
    
 
     
      [bookmark: pgfId-1649761][bookmark: 24306]Viewing the Indications by Host Graph
 
     [bookmark: pgfId-1648891]License: FireSIGHT
 
     [bookmark: pgfId-1648985]The Indications by Host graph, in bar form, displays counts of unique Indications of Compromise (IOC) triggered by the 15 most IOC-active hosts on your monitored network.
 
     [bookmark: pgfId-1730886]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1649010]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1650778]This graph draws data primarily from the Hosts and Indications of Compromise tables.
 
    
 
     
      [bookmark: pgfId-1575301][bookmark: 89844]Understa[bookmark: marker-1575299]nding the Network Information Section
 
     [bookmark: pgfId-1575305]License: FireSIGHT
 
     [bookmark: pgfId-1521445]The Network Information section of the Context Explorer contains six interactive graphs that display an overall picture of connection traffic on your monitored network: sources, destinations, users, and security zones associated with traffic, a breakdown of operating systems used by hosts on the network, as well as a proportional view of access control actions your FireSIGHT System has performed on network traffic.
 
     [bookmark: pgfId-1530558]For more information on the graphs in the Network Information section, see the following topics:
 
      
      	 [bookmark: pgfId-1530682]Viewing the Operating Systems Graph
 
      	 [bookmark: pgfId-1531101]Viewing the Traffic by Source IP Graph
 
      	 [bookmark: pgfId-1531123]Viewing the Traffic by Source User Graph
 
      	 [bookmark: pgfId-1531145]Viewing the Connections by Access Control Action Graph
 
      	 [bookmark: pgfId-1531167]Viewing the Traffic by Destination IP Graph
 
      	 [bookmark: pgfId-1531189]Viewing the Traffic by Ingress/Egress Security Zone Graph
 
     
 
    
 
     
      [bookmark: pgfId-1530689][bookmark: 54512]Viewing the Op[bookmark: marker-1575959]erating Sys[bookmark: marker-1575388]tems Graph
 
     [bookmark: pgfId-1530789]License: FireSIGHT
 
     [bookmark: pgfId-1529671]The Operating Systems graph, in donut form, displays a proportional representation of operating systems detected on hosts on your monitored network. The inner ring divides by OS name (such as Windows or Linux), while the outer ring further divides that data by specific operating system version (such as Windows Server 2008 or Linux 11.x). Some closely related operating systems (such as Windows 2000, Windows XP, and Windows Server 2003) are grouped together. Very scarce or unrecognized operating systems are grouped under Other.
 
     [bookmark: pgfId-1580489]Note that this graph reflects all available data regardless of date and time constraints. If you change the explorer time range, the graph does not change.
 
     [bookmark: pgfId-1730894]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1530196]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1575410]This graph draws data primarily from the Hosts table.
 
    
 
     
      [bookmark: pgfId-1575412][bookmark: 86520]Viewing the Traffic by Sour[bookmark: marker-1575423]ce IP Graph
 
     [bookmark: pgfId-1575416]License: FireSIGHT
 
     [bookmark: pgfId-1531397]The Traffic by Source IP graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top 15 most active source IP addresses on your monitored network. For each source IP address listed, blue bars represent traffic data and red bars represent connection data.
 
     [bookmark: pgfId-1730902]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1532316]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532413]Note If you filter on intrusion event information, the Traffic by Source IP graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1575456]This graph draws data primarily from the Connection Events table.
 
    
 
     
      [bookmark: pgfId-1575458][bookmark: 16866]Viewing the Traffic by Sour[bookmark: marker-1575466]ce User Graph
 
     [bookmark: pgfId-1575462]License: FireSIGHT
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1532756]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1532757]Note If you filter on intrusion event information, the Traffic by Source User graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1532758]This graph draws data primarily from the Connection Events table. Note that it displays only users reported by the User Agent.
 
    
 
     
      [bookmark: pgfId-1532321][bookmark: 61295]Viewing the Connections by Access Co[bookmark: marker-1575480]ntrol Action Graph
 
     [bookmark: pgfId-1532842]License: FireSIGHT
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1533304]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533445]Note If you filter on intrusion event information, the Traffic by Source User graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533362]This graph draws data primarily from the Connection Events table.
 
    
 
     
      [bookmark: pgfId-1530957][bookmark: 97701]Viewing the Traffic by Desti[bookmark: marker-1575489]nation IP Graph
 
     [bookmark: pgfId-1533474]License: FireSIGHT
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1533727]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1533728]Note If you filter on intrusion event information, the Traffic by Destination IP graph is hidden.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1533723]This graph draws data primarily from the Connection Events table.
 
    
 
     
      [bookmark: pgfId-1531007][bookmark: 10245]Viewing the Traffic by Ingress/Egress S[bookmark: marker-1575550]ecurity Zone Graph
 
     [bookmark: pgfId-1533492]License: FireSIGHT
 
     [bookmark: pgfId-1577281]The Traffic by Ingress/Egress Security Zone graph, in bar form, displays counts of incoming or outgoing network traffic (in kilobytes per second) and unique connections for each security zone configured on your monitored network. You can configure this graph to display either ingress (the default) or egress security zone information, according to your needs.
 
     [bookmark: pgfId-1533845]For each security zone listed, blue bars represent traffic data and red bars represent connection data. For information about security zones, see Working with Security Zones.
 
     [bookmark: pgfId-1730934]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1533759]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information
 
      
       
     
 
     
 
     [bookmark: pgfId-1618120]Tip To constrain the graph so it displays only traffic by egress security zone, hover your pointer over the graph, then click Egress on the toggle button that appears. Click Ingress to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Ingress view.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1535289]Note If you filter on intrusion event information, the Traffic by Ingress/Egress Security Zone graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1535290]This graph draws data primarily from the Connection Events table.
 
    
 
     
      [bookmark: pgfId-1521272][bookmark: 96864]Understa[bookmark: marker-1574584]nding the Applicati[bookmark: marker-1574951]on Information Section
 
     [bookmark: pgfId-1535458]License: FireSIGHT
 
     [bookmark: pgfId-1535511]The Application Information section of the Context Explorer contains three interactive graphs and one table-format list that display an overall picture of application activity on your monitored network: traffic, intrusion events, and hosts associated with applications, further organized by the estimated risk or business relevance assigned to each application. The Application Details list provides an interactive list of each application and its risk, business relevance, category, and host count.
 
     [bookmark: pgfId-1536042]For all instances of “application” in this section, the Application Information graph set, by default, specifically examines application protocols (such as DNS or SSH). You can also configure the Application Information section to specifically examine client applications (such as PuTTY or Firefox) or web applications (such as Facebook or Pandora).
 
     [bookmark: pgfId-1577425]For more information on the graphs and list in the Application Information section, see the following topics:
 
      
      	 [bookmark: pgfId-1577428]Viewing the Traffic by Risk/Business Relevance and Application Graph
 
      	 [bookmark: pgfId-1577432]Viewing the Intrusion Events by Risk/Business Relevance and Application Graph
 
      	 [bookmark: pgfId-1577436]Viewing the Hosts by Risk/Business Relevance and Application Graph
 
      	 [bookmark: pgfId-1577441]Viewing the Application Details List
 
     
 
     [bookmark: pgfId-1521457]To configure the Application Information section focus:
 
     [bookmark: pgfId-1536648]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1536680]Step 1 Select Analysis > Context Explorer.
 
     [bookmark: pgfId-1537132]The Context Explorer appears.
 
     [bookmark: pgfId-1536734]Step 2 Hover your pointer over the Application Protocol Information section. (Note that if you previously changed this setting in the same Context Explorer session, the section title may appear as Client Application Information or Web Application Information instead.)
 
     [bookmark: pgfId-1537195]The section option buttons appear at the upper right.
 
     [bookmark: pgfId-1537272]Step 3 Click Application Protocol, Client Application, or Web Application.
 
     [bookmark: pgfId-1537493]The Application Information section refreshes according to the option you selected.
 
      
       
     
 
     
 
     [bookmark: pgfId-1537676]Note If you navigate away from the Context Explorer, this section reverts to its default state (Application Protocol).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1695933]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1576095][bookmark: 57449]Viewing the Traffic by Risk/Business Rele[bookmark: marker-1576094]vance and Application Graph
 
     [bookmark: pgfId-1576099]License: FireSIGHT
 
     [bookmark: pgfId-1539218]The Traffic by Risk/Business Relevance and Application graph, in donut form, displays a proportional representation of application traffic detected on your monitored network, arranged by the applications’ estimated risk (the default) or estimated business relevance. The inner ring divides by estimated risk/business relevance level (such as Medium or High), while the outer ring further divides that data by specific application (such as SSH or NetBIOS). Scarcely detected applications are grouped under Other.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1609532]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1618681]Tip To constrain the graph so it displays traffic by business relevance and application, hover your pointer over the graph, then click Business Relevance on the toggle button that appears. Click Risk to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Risk view.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1539641]Note If you filter on intrusion event information, the Traffic by Risk/Business and Application graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1618840]This graph draws data primarily from the Connection Events and Application Statistics tables.
 
    
 
     
      [bookmark: pgfId-1618847][bookmark: 95181]Viewing the Intrusion Events by Risk/Bus[bookmark: marker-1618846]iness Relevance and Application Graph
 
     [bookmark: pgfId-1538229]License: FireSIGHT
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1609517]Hover your pointer over any part of the donut graph to view more detailed information. Click any part of the graph to filter or drill down on that information, or (where applicable) to view application information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1618887]Tip To constrain the graph so it displays intrusion events by business relevance and application, hover your pointer over the graph, then click Business Relevance on the toggle button that appears. Click Risk to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Risk view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1541015]This graph draws data primarily from the Intrusion Events and Application Statistics tables.
 
    
 
     
      [bookmark: pgfId-1576166][bookmark: 48779]Viewing the Hosts by Risk/Business Releva[bookmark: marker-1576165]nce and Application Graph
 
     [bookmark: pgfId-1576170]License: FireSIGHT
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1541158]Hover your pointer over any part of the donut graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1619037]Tip To constrain the graph so it displays hosts by business relevance and application, hover your pointer over the graph, then click Business Relevance on the toggle button that appears. Click Risk to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Risk view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1541160]This graph draws data primarily from the Applications table.
 
    
 
     
      [bookmark: pgfId-1538082][bookmark: 65587]Viewing the Appl[bookmark: marker-1576202]ication D[bookmark: marker-1575663]etails List
 
     [bookmark: pgfId-1538261]License: FireSIGHT
 
     [bookmark: pgfId-1541310]At the bottom of the Application Information section is the Application Details List, a table that provides estimated risk, estimated business relevance, category, and hosts count information for each application detected on your monitored network. The applications are listed in descending order of associated host count.
 
     [bookmark: pgfId-1580978]The Application Details List table is not sortable, but you can click on any table entry to filter or drill down on that information, or (where applicable) to view application information. This table draws data primarily from the Applications table.
 
     [bookmark: pgfId-1580997]Note that this list reflects all available data regardless of date and time constraints. If you change the explorer time range, the list does not change.
 
    
 
     
      [bookmark: pgfId-1643152][bookmark: 62974]Understanding th[bookmark: marker-1653067]e Security Intelligen[bookmark: marker-1653546]ce Section
 
     [bookmark: pgfId-1720703]License: Protection
 
     [bookmark: pgfId-1720710]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1720717]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1646951]The Security Intelligence section of the Context Explorer contains three interactive bar graphs that display an overall picture of traffic on your monitored network that is blacklisted or monitored by Security Intelligence. The graphs sort such traffic by category, source IP address, and destination IP address, respectively; both the amount of traffic (in kilobytes per second) and the number of applicable connections appear.
 
     [bookmark: pgfId-1646952]For more information on the graphs in the Security Intelligence section, see the following topics:
 
      
      	 [bookmark: pgfId-1644402]Viewing the Security Intelligence Traffic by Category Graph
 
      	 [bookmark: pgfId-1644472]Viewing the Security Intelligence Traffic by Source IP Graph
 
      	 [bookmark: pgfId-1644478]Viewing the Security Intelligence Traffic by Destination IP Graph
 
     
 
    
 
     
      [bookmark: pgfId-1644116][bookmark: 98617]Viewing the Security Intelligence Traffic by Category Graph
 
     [bookmark: pgfId-1644527]License: Protection
 
     [bookmark: pgfId-1644531]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1644572]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1644585]The Security Intelligence Traffic by Category graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top Security Intelligence categories of traffic on your monitored network. For each category listed, blue bars represent traffic data and red bars represent connection data.
 
     [bookmark: pgfId-1645119]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1644863]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1645065]Note If you filter on intrusion event information, the Security Intelligence Traffic by Category graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1644887]This graph draws data primarily from the Security Intelligence Events table.
 
    
 
     
      [bookmark: pgfId-1644257][bookmark: 91825]Viewing the Security Intelligence Traffic by Source IP Graph
 
     [bookmark: pgfId-1645227]License: Protection
 
     [bookmark: pgfId-1645231]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1645235]Supported Defense Centers: Any except DC500
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1645385]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1645386]Note If you filter on intrusion event information, the Security Intelligence Traffic by Source IP graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1645387]This graph draws data primarily from the Security Intelligence Events table.
 
    
 
     
      [bookmark: pgfId-1644325][bookmark: 38945]Viewing the Security Intelligence Traffic by Destination IP Graph
 
     [bookmark: pgfId-1645468]License: Protection
 
     [bookmark: pgfId-1645472]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-1645476]Supported Defense Centers: Any except DC500
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1645538]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1645539]Note If you filter on intrusion event information, the Security Intelligence Traffic by Destination IP graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1645540]This graph draws data primarily from the Security Intelligence Events table.
 
    
 
     
      [bookmark: pgfId-1580983][bookmark: 85303]Understan[bookmark: marker-1580981]ding the Intrusion Infor[bookmark: marker-1580982]mation Section
 
     [bookmark: pgfId-1542304]License: Protection
 
     [bookmark: pgfId-1542359]The Intrusion Information section of the Context Explorer contains six interactive graphs and one table-format list that display an overall picture of intrusion events on your monitored network: impact levels, attack sources, target destinations, users, priority levels, and security zones associated with intrusion events, as well as a detailed list of intrusion event classifications, priorities, and counts.
 
     [bookmark: pgfId-1542363]For more information on the graphs and list in the Network Information section, see the following topics:
 
      
      	 [bookmark: pgfId-1542939]Viewing the Intrusion Events by Impact Graph
 
      	 [bookmark: pgfId-1542955]Viewing the Top Attackers Graph
 
      	 [bookmark: pgfId-1542961]Viewing the Top Users Graph
 
      	 [bookmark: pgfId-1542967]Viewing the Intrusion Events by Priority Graph
 
      	 [bookmark: pgfId-1542973]Viewing the Top Targets Graph
 
      	 [bookmark: pgfId-1542979]Viewing the Top Ingress/Egress Security Zones Graph
 
      	 [bookmark: pgfId-1545533]Viewing the Intrusion Event Details List
 
     
 
    
 
     
      [bookmark: pgfId-1521472][bookmark: 50714]Viewing the Intrusion Eve[bookmark: marker-1575683]nts by Impact Graph
 
     [bookmark: pgfId-1543010]License: Protection
 
     [bookmark: pgfId-1543260]The Intrusion Events by Impact graph, in pie form, displays a proportional view of intrusion events on your monitored network, grouped by estimated impact level (from 0 to 4).
 
     [bookmark: pgfId-1730990]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1651745]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1651746]This graph draws data primarily from the IDS Statistics and Intrusion Events tables.
 
    
 
     
      [bookmark: pgfId-1542714][bookmark: 77958]Viewing the Top Atta[bookmark: marker-1575700]ckers Graph
 
     [bookmark: pgfId-1543036]License: Protection
 
     [bookmark: pgfId-1543562]The Top Attackers graph, in bar form, displays counts of intrusion events for the top attacking host IP addresses (causing those events) on your monitored network.
 
     [bookmark: pgfId-1730998]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1543770]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1589795]This graph draws data primarily from the Intrusion Events table.
 
    
 
     
      [bookmark: pgfId-1589799][bookmark: 10756]Viewing the T[bookmark: marker-1589797]op Use[bookmark: marker-1589798]rs Graph
 
     [bookmark: pgfId-1589803]License: Protection
 
     [bookmark: pgfId-1543921]The Top Users graph, in bar form, displays users on your monitored network that are associated with the highest intrusion event counts, by event count.
 
     [bookmark: pgfId-1731006]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1543923]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1638008]This graph draws data primarily from the IDS User Statistics and Intrusion Events tables. Note that it displays only users reported by the User Agent.
 
    
 
     
      [bookmark: pgfId-1638012][bookmark: 53425]Viewing the Intr[bookmark: marker-1638010]usion Eve[bookmark: marker-1638011]nts by Priority Graph
 
     [bookmark: pgfId-1543072]License: Protection
 
     [bookmark: pgfId-1544196]The Intrusion Events by Priority graph, in pie form, displays a proportional view of intrusion events on your monitored network, grouped by estimated priority level (such as High, Medium, or Low).
 
     [bookmark: pgfId-1731014]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1544298]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1544290]This graph draws data primarily from the Intrusion Events table.
 
    
 
     
      [bookmark: pgfId-1542837][bookmark: 17618]Viewing the Top Tar[bookmark: marker-1575737]gets Graph
 
     [bookmark: pgfId-1543086]License: Protection
 
     [bookmark: pgfId-1544358]The Top Targets graph, in bar form, displays counts of intrusion events for the top target host IP addresses (targeted in the connections causing those events) on your monitored network.
 
     [bookmark: pgfId-1731022]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1544379]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1544375]This graph draws data primarily from the Intrusion Events table.
 
    
 
     
      [bookmark: pgfId-1542874][bookmark: 25409]Viewing the Top[bookmark: marker-1576276] Ingress/Egress [bookmark: marker-1575755]Security Zones Graph
 
     [bookmark: pgfId-1543121]License: Protection
 
     [bookmark: pgfId-1544722]The Top Ingress/Egress Security Zones graph, in bar form, displays counts of intrusion events associated with each security zone (ingress or egress, depending on graph settings) configured on your monitored network. For information about security zones, see Working with Security Zones.
 
     [bookmark: pgfId-1731030]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1544900]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1619225]Tip To constrain the graph so it displays only traffic by egress security zone, hover your pointer over the graph, then click Egress on the toggle button that appears. Click Ingress to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Ingress view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1544902]This graph draws data primarily from the Intrusion Events table.
 
     [bookmark: pgfId-1544903]You can configure this graph to display either ingress (the default) or egress security zone information, according to your needs.
 
    
 
     
      [bookmark: pgfId-1601547][bookmark: 52913]Viewing the Intru[bookmark: marker-1601545]sion Event D[bookmark: marker-1601546]etails List
 
     [bookmark: pgfId-1545172]License: Protection
 
     [bookmark: pgfId-1545208]At the bottom of the Intrusion Information section is the Intrusion Event Details List, a table that provides classification, estimated priority, and event count information for each intrusion event detected on your monitored network. The events are listed in descending order of event count.
 
     [bookmark: pgfId-1545293]The Intrusion Event Details List table is not sortable, but you can click on any table entry to filter or drill down on that information. This table draws data primarily from the Intrusion Events table.
 
    
 
     
      [bookmark: pgfId-1593661][bookmark: 96097]Underst[bookmark: marker-1593659]anding the Files Infor[bookmark: marker-1593660]mation Section
 
     [bookmark: pgfId-1593681]License: Protection or Malware
 
     [bookmark: pgfId-1630262]Supported Devices: feature dependent
 
     [bookmark: pgfId-1630303]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1598784]The Files Information section of the Context Explorer contains six interactive graphs that display an overall picture of file and malware events on your monitored network. Five of the graphs display the file types, file names, and malware dispositions of the files detected in network traffic, as well as the hosts sending (uploading) and receiving (downloading) those files. The final graph displays the malware threats detected on your network and, if you have a FireAMP subscription, on the endpoints where your users installed FireAMP Connectors.
 
      
       
     
 
     
 
     [bookmark: pgfId-1598785]Note If you filter on intrusion information, the entire Files Information Section is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1596845]Note that you must have a Malware license and enable malware detection for Files Information graphs to include network-based malware data. Note also that the DC500 Defense Center and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, so the DC500 Defense Center cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. See Understanding Malware Protection and File Control.
 
     [bookmark: pgfId-1630458]For more information on the graphs in the Files Information section, see the following topics:
 
      
      	 [bookmark: pgfId-1596849]Viewing the Top File Types Graph
 
      	 [bookmark: pgfId-1596860]Viewing the Top File Names Graph
 
      	 [bookmark: pgfId-1596891]Viewing the Files by Disposition Graph
 
      	 [bookmark: pgfId-1596909]Viewing the Top Hosts Sending Files Graph
 
      	 [bookmark: pgfId-1596927]Viewing the Top Hosts Receiving Files Graph
 
      	 [bookmark: pgfId-1596945]Viewing the Top Malware Detections Graph
 
     
 
    
 
     
      [bookmark: pgfId-1596851][bookmark: 45769]Viewing the Top[bookmark: marker-1605347] File Types Graph
 
     [bookmark: pgfId-1630847]License: Protection or Malware
 
     [bookmark: pgfId-1630848]Supported Devices: feature dependent
 
     [bookmark: pgfId-1630849]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1599990]The Top File Types graph, in donut form, displays a proportional view of the file types detected in network traffic (outer ring), grouped by file category (inner ring).
 
     [bookmark: pgfId-1731038]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1600239]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1718715]Note that you must have a Malware license and enable malware detection for this graph to include network-based malware data. Note also that the DC500 Defense Center and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, so the DC500 Defense Center cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. See Understanding Malware Protection and File Control.
 
     [bookmark: pgfId-1599800]This graph draws data primarily from the File Events table.
 
    
 
     
      [bookmark: pgfId-1596530][bookmark: 52004]Viewing the Top File Names [bookmark: marker-1605352]Graph
 
     [bookmark: pgfId-1630884]License: Protection or Malware
 
     [bookmark: pgfId-1630885]Supported Devices: feature dependent
 
     [bookmark: pgfId-1630886]Supported Defense Centers: feature dependent
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1601612]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1630595]Note that you must have a Malware license and enable malware detection for this graph to include network-based malware data. Note also that the DC500 Defense Center and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, so the DC500 Defense Center cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. See Understanding Malware Protection and File Control.
 
     [bookmark: pgfId-1601614]This graph draws data primarily from the File Events table.
 
    
 
     
      [bookmark: pgfId-1596425][bookmark: 77031]Viewing the Files by Dispos[bookmark: marker-1605357]ition Graph
 
     [bookmark: pgfId-1630917]License: Protection or Malware
 
     [bookmark: pgfId-1630918]Supported Devices: feature dependent
 
     [bookmark: pgfId-1630919]Supported Defense Centers: feature dependent
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1621785]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1630641]Note that you must have a Malware license and enable malware detection for this graph to include network-based malware data. Note also that the DC500 Defense Center and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, so the DC500 Defense Center cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. See Understanding Malware Protection and File Control.
 
     [bookmark: pgfId-1600305]This graph draws data primarily from the File Events table.
 
    
 
     
      [bookmark: pgfId-1596442][bookmark: 88423]Viewing the Top Hosts Sending[bookmark: marker-1605362] Files Graph
 
     [bookmark: pgfId-1630941]License: Protection or Malware
 
     [bookmark: pgfId-1630942]Supported Devices: feature dependent
 
     [bookmark: pgfId-1630943]Supported Defense Centers: feature dependent
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1601512]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1602092]Tip To constrain the graph so it displays only hosts sending malware, hover your pointer over the graph, then click Malware on the toggle button that appears. Click Files to return to the default files view. Note that navigating away from the Context Explorer also returns the graph to the default files view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1630679]Note that you must have a Malware license and enable malware detection for this graph to include network-based malware data. Note also that the DC500 Defense Center and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, so the DC500 Defense Center cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. See Understanding Malware Protection and File Control.
 
     [bookmark: pgfId-1601513]This graph draws data primarily from the File Events table.
 
    
 
     
      [bookmark: pgfId-1601063][bookmark: 44020]Viewing the Top Hosts Receivi[bookmark: marker-1605367]ng Files Graph
 
     [bookmark: pgfId-1630976]License: Protection or Malware
 
     [bookmark: pgfId-1630977]Supported Devices: feature dependent
 
     [bookmark: pgfId-1630978]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1602265]The Top Hosts Receiving Files graph, in bar form, displays counts of the number of files detected in network traffic for the top file-receiving host IP addresses.
 
     [bookmark: pgfId-1731070]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1602444]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1641778]Tip To constrain the graph so it displays only hosts receiving malware, hover your pointer over the graph, then click Malware on the toggle button that appears. Click Files to return to the default files view. Note that navigating away from the Context Explorer also returns the graph to the default files view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1641779]Note that you must have a Malware license and enable malware detection for this graph to include network-based malware data. Note also that the DC500 Defense Center and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, so the DC500 Defense Center cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. See Understanding Malware Protection and File Control.
 
     [bookmark: pgfId-1602271]This graph draws data primarily from the File Events table.
 
    
 
     
      [bookmark: pgfId-1596488][bookmark: 37460]Viewing the Top Malware Dete[bookmark: marker-1605372]ctions Graph
 
     [bookmark: pgfId-1631008]License: Protection or Malware
 
     [bookmark: pgfId-1631009]Supported Devices: feature dependent
 
     [bookmark: pgfId-1631010]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1602374]The Top Malware Detections graph, in bar form, displays counts of the top malware threats detected on your network and, if you have a FireAMP subscription, on the endpoints where your users installed FireAMP Connectors.
 
     [bookmark: pgfId-1731078]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1602378]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
     [bookmark: pgfId-1630739]Note that you must have a Malware license and enable malware detection for this graph to include network-based malware data. Note also that the DC500 Defense Center and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, so the DC500 Defense Center cannot display this data and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect it. See Understanding Malware Protection and File Control.
 
     [bookmark: pgfId-1618069]This graph draws data primarily from the File Events and Malware Events tables.
 
    
 
     
      [bookmark: pgfId-1618071][bookmark: 26594]Understanding the Geolocation Information Section
 
     [bookmark: pgfId-1618075]License: FireSIGHT
 
     [bookmark: pgfId-1619870]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1613787]The Geolocation Information section of the Context Explorer contains three interactive donut graphs that display an overall picture of countries with which hosts on your monitored network are exchanging data: unique connections by initiator or responder country, intrusion events by source or destination country, and file events by sending or receiving country.
 
     [bookmark: pgfId-1614607]For more information on the graphs in the Geolocation Information section, see the following topics:
 
      
      	 [bookmark: pgfId-1615100]Viewing the Connections by Initiator/Responder Country Graph
 
      	 [bookmark: pgfId-1615161]Viewing the Intrusion Events by Source/Destination Country Graph
 
      	 [bookmark: pgfId-1615195]Viewing the File Events by Sending/Receiving Country Graph
 
     
 
    
 
     
      [bookmark: pgfId-1614845][bookmark: 70762]Viewing the Connections by Initiator/Responder Country Graph
 
     [bookmark: pgfId-1615244]License: FireSIGHT
 
     [bookmark: pgfId-1629089]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1655520]The Connections by Initiator/Responder Country graph, in donut form, displays a proportional view of the countries involved in connections on your network as either the initiator (the default) or the responder. The inner ring groups these countries together by continent. For information about geolocation information, see Using Geolocation. For information about connection data, see Working with Connection & Security Intelligence Data.
 
     [bookmark: pgfId-1731086]
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     [bookmark: pgfId-1655555]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1655490]Tip To constrain the graph so it displays only countries acting as the responder in connections, hover your pointer over the graph, then click Responder on the toggle button that appears. Click Initiator to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Initiator view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1616502]This graph draws data primarily from the Connection Summary Data table.
 
    
 
     
      [bookmark: pgfId-1614908][bookmark: 77016]Viewing the Intrusion Events by Source/Destination Country Graph
 
     [bookmark: pgfId-1615392]License: FireSIGHT
 
     [bookmark: pgfId-1629116]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1616640]The Intrusion Events by Source/Destination Country graph, in donut form, displays a proportional view of the countries involved in intrusion events on your network as either the source of the event (the default) or the destination. The inner ring groups these countries together by continent. For information about geolocation information, see Using Geolocation. For information about intrusion event data, see Working with Intrusion Events.
 
     [bookmark: pgfId-1731094]
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     [bookmark: pgfId-1616962]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1616963]Tip To constrain the graph so it displays only countries acting as the destinations of intrusion events, hover your pointer over the graph, then click Destination on the toggle button that appears. Click Source to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Source view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1616964]This graph draws data primarily from the Intrusion Events table.
 
    
 
     
      [bookmark: pgfId-1614989][bookmark: 58048]Viewing the File Events by Sending/Receiving Country Graph
 
     [bookmark: pgfId-1615440]License: FireSIGHT
 
     [bookmark: pgfId-1629142]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-1617136]The File Events by Sending/Receiving Country graph, in donut form, displays a proportional view of the countries detected in file events on your network as either sending (the default) or receiving files. The inner ring groups these countries together by continent. For information about geolocation information, see Using Geolocation. For information about file event data, see Working with File Events.
 
     [bookmark: pgfId-1731102]
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     [bookmark: pgfId-1617138]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to filter or drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1617139]Tip To constrain the graph so it displays only countries receiving files, hover your pointer over the graph, then click Receiver on the toggle button that appears. Click Sender to return to the default view. Note that navigating away from the Context Explorer also returns the graph to the default Sender view.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1617140]This graph draws data primarily from the File Events table.
 
    
 
     
      [bookmark: pgfId-1541276][bookmark: 64302]Underst[bookmark: marker-1574690]anding the URL Infor[bookmark: marker-1575011]mation Section
 
     [bookmark: pgfId-1542322]License: FireSIGHT or URL Filtering
 
     [bookmark: pgfId-1629495]Supported Devices: feature dependent
 
     [bookmark: pgfId-1629541]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1545719]The URL Information section of the Context Explorer contains three interactive bar graphs that display an overall picture of URLs with which hosts on your monitored network are exchanging data: traffic and unique connections associated with URLs, sorted by individual URL, URL category, and URL reputation. You cannot filter on URL information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1629811]Note If you filter on intrusion event information, the entire URL Information Section is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1629979]Note that you must have a URL Filtering license and enable URL Filtering for URL filtering graphs to include URL category and reputation data. Note also that neither the DC500 Defense Center nor Series 2 devices support URL filtering by reputation and category, so the DC500 Defense Center cannot display this data and Series 2 devices do not detect it. See Blocking URLs.
 
     [bookmark: pgfId-1629989]For more information on the graphs in the URL Information section, see the following topics:
 
      
      	 [bookmark: pgfId-1629993]Viewing the Traffic by URL Graph
 
      	 [bookmark: pgfId-1629997]Viewing the Traffic by URL Category Graph
 
      	 [bookmark: pgfId-1630001]Viewing the Traffic by URL Reputation Graph
 
     
 
    
 
     
      [bookmark: pgfId-1630015][bookmark: 71165]Viewing the Tr[bookmark: marker-1630013]affic by U[bookmark: marker-1630014]RL Graph
 
     [bookmark: pgfId-1630019]License: FireSIGHT or URL Filtering
 
     [bookmark: pgfId-1634559]Supported Devices: feature dependent
 
     [bookmark: pgfId-1634560]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1630020]The Traffic by URL graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the top 15 most requested URLs on your monitored network. For each URL listed, blue bars represent traffic data and red bars represent connection data.
 
     [bookmark: pgfId-1731110]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-1546414]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1546415]Note If you filter on intrusion event information, the Traffic by URL graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1546416]Note that you must have a URL Filtering license and enable URL Filtering for URL filtering graphs to include URL category and reputation data. Note also that neither the DC500 Defense Center nor Series 2 devices support URL filtering by reputation and category, so the DC500 Defense Center cannot display this data and Series 2 devices do not detect it. See Enabling Cloud Communications.
 
     [bookmark: pgfId-1630073]This graph draws data primarily from the Connection Events table.
 
    
 
     
      [bookmark: pgfId-1629930][bookmark: 13309]Viewing the Tr[bookmark: marker-1629928]affic by URL Cate[bookmark: marker-1629929]gory Graph
 
     [bookmark: pgfId-1629934]License: URL Filtering
 
     [bookmark: pgfId-1634575]Supported Devices: feature dependent
 
     [bookmark: pgfId-1634576]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1629935]The Traffic by URL Category graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the most requested URL categories (such as Search Engines or Streaming Media) on your monitored network. For each URL category listed, blue bars represent traffic data and red bars represent connection data.
 
     [bookmark: pgfId-1731118]
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     [bookmark: pgfId-1546608]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1546609]Note If you filter on intrusion event information, the Traffic by URL Category graph is hidden.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1629878]Note that you must have a URL Filtering license and enable URL Filtering for URL filtering graphs to include URL category and reputation data. Note also that neither the DC500 Defense Center nor Series 2 devices support URL filtering by reputation and category, so the DC500 Defense Center cannot display this data and Series 2 devices do not detect it. See Performing Reputation-Based URL Blocking.
 
     [bookmark: pgfId-1630107]This graph draws data primarily from the URL Statistics and Connection Events tables.
 
    
 
     
      [bookmark: pgfId-1629892][bookmark: 84755]Viewing the Traff[bookmark: marker-1629890]ic by URL Rep[bookmark: marker-1629891]utation Graph
 
     [bookmark: pgfId-1629870]License: URL Filtering
 
     [bookmark: pgfId-1634601]Supported Devices: feature dependent
 
     [bookmark: pgfId-1634602]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1629871]The Traffic by URL Reputation graph, in bar form, displays counts of network traffic (in kilobytes per second) and unique connections for the most requested URL reputation groups (such as Well known or Benign sites with security risks) on your monitored network. For each URL reputation listed, blue bars represent traffic data and red bars represent connection data.
 
     [bookmark: pgfId-1731126]
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     [bookmark: pgfId-1546889]Hover your pointer over any part of the graph to view more detailed information. Click any part of the graph to drill down on that information.
 
      
       
     
 
     
 
     [bookmark: pgfId-1546890]Note If you filter on intrusion event information, the Traffic by URL Reputation graph is hidden. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1629838]Note that you must have a URL Filtering license and enable URL Filtering for URL filtering graphs to include URL category and reputation data. Note also that neither the DC500 Defense Center nor Series 2 devices support URL filtering by reputation and category, so the DC500 Defense Center cannot display this data and Series 2 devices do not detect it. See Performing Reputation-Based URL Blocking.
 
     [bookmark: pgfId-1630249]This graph draws data primarily from the URL Statistics and Connection Events tables.
 
    
 
     
      [bookmark: pgfId-1629852][bookmark: 22106]Refres[bookmark: marker-1629850]hing the Context Explor[bookmark: marker-1629851]er
 
     [bookmark: pgfId-1634632]License: FireSIGHT
 
     [bookmark: pgfId-1634633]The Context Explorer does not automatically update the information it displays. To incorporate new data, you must manually refresh the explorer.
 
     [bookmark: pgfId-1546401]Note that, although reloading the Context Explorer itself (by refreshing the browser program or navigating away from, then back to, the Context Explorer) refreshes all displayed information, this does not preserve any changes you made to section configuration (such as the Ingress/Egress graphs and the Application Information section) and may cause delays in loading.
 
     [bookmark: pgfId-1546405]To refresh the Context Explorer:
 
     [bookmark: pgfId-1547962]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1548011]Step 1 On the Context Explorer, click Reload at the upper right.
 
     [bookmark: pgfId-1547964]The explorer updates to display the latest information within your selected time range. Note that the Reload button is grayed out until your refresh is finished.
 
     [bookmark: pgfId-1696135]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1522629][bookmark: 13646]Settin[bookmark: marker-1574721]g the Context Explorer Time Range
 
     [bookmark: pgfId-1548456]License: FireSIGHT
 
     [bookmark: pgfId-1548692]You can configure the Context Explorer time range to reflect a period as short as the last hour (the default) or as long as the last year. Note that when you change the time range, the Context Explorer does not automatically update to reflect the change. To apply the new time range, you must manually refresh the explorer.
 
     [bookmark: pgfId-1610630]Changes to the time range persist even if you navigate away from the Context Explorer or end your login session.
 
     [bookmark: pgfId-1549068]To change the Context Explorer time range:
 
     [bookmark: pgfId-1549126]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1549171]Step 1 From the Show the last drop-down list, select a time range.
 
     [bookmark: pgfId-1549220]Step 2 Optionally, to view data from the new time range, click Reload.
 
     [bookmark: pgfId-1549313]All sections of the Context Explorer update to reflect the new time range.
 
      
       
     
 
     
 
     [bookmark: pgfId-1549413]Tip Clicking Apply Filters also applies any time range updates.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1696142]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1522574][bookmark: 95961]Minimizing and Maximizing Context Explorer Sections
 
     [bookmark: pgfId-1549718]License: FireSIGHT
 
     [bookmark: pgfId-1549722]You can minimize and hide one or more sections of the Context Explorer. This is useful if you want to focus on only certain sections, or if you want a simpler view. You cannot minimize the Traffic and Intrusion Event Counts Time Graph.
 
     [bookmark: pgfId-1581058]Note that Context Explorer sections retain the minimized or maximized states that you configure even if you refresh the page or log out of the appliance.
 
     [bookmark: pgfId-1549873]To minimize a Context Explorer section:
 
     [bookmark: pgfId-1549926]Access: Admin/Any Security Analyst
 
     
 ) in a section’s title bar. 
     
 
     [bookmark: pgfId-1696175]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1550340]To maximize a Context Explorer section:
 
     [bookmark: pgfId-1550431]Access: Admin/Any Security Analyst
 
     
 ) in a minimized section’s title bar. 
     
 
     [bookmark: pgfId-1696159]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1549727][bookmark: 15803]Drilling Down on Context Explor[bookmark: marker-1586269]er Data
 
     [bookmark: pgfId-1548466]License: feature dependent
 
     [bookmark: pgfId-1550736]If you want to examine graph or list data in more detail than the Context Explorer allows, you can drill down to the table views of the relevant data. (Note that you cannot drill down on the Traffic and Intrusion Events over Time graph.) For example, drilling down on an IP address in the Traffic by Source IP graph displays the Connections with Application Details view of the Connection Events table, including only data associated with the source IP address you selected.
 
     [bookmark: pgfId-1552667]Depending on the type of data you examine, additional options can appear in the context menu. Data points that are associated with specific IP addresses offer the option to view host or whois information on the IP address you select. Data points associated with specific applications offer the option to view application information on the application you select. Data points associated with a specific user offer the option to view that user’s user profile page. Data points associated with an intrusion event message offer the option to view the rule documentation for that event’s associated intrusion rule, and data points associated with a specific IP address offer the option to blacklist or whitelist that address.
 
     [bookmark: pgfId-1554624]The context menu that you use to drill down on data also contains options to filter that data. For more information on filtering, see Working with Filters in the Context Explorer.
 
     [bookmark: pgfId-1551249]To drill down on data in the Context Explorer:
 
     [bookmark: pgfId-1551311]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1551339]Step 1 Select Analysis > Context Explorer.
 
     [bookmark: pgfId-1551370]The Context Explorer appears.
 
     [bookmark: pgfId-1551401]Step 2 In any section but Traffic and Intrusion Events over Time, click a data point that you want to investigate.
 
     [bookmark: pgfId-1557178]The context menu pop-up window appears nearby. 
 
     [bookmark: pgfId-1551873]Step 3 Depending on the data point you selected, you have several options:
 
      
       
       	 [bookmark: pgfId-1553060]To view more details of this data in a table view, select  Drill into Analysis .
 
      
 
     
 
     [bookmark: pgfId-1553194]A new window opens with a detailed table view of the data you selected.
 
      
       
       	 [bookmark: pgfId-1553108]If you selected a data point associated with a specific IP address and want more information about the associated host, select  View Host Information .
 
      
 
     
 
     [bookmark: pgfId-1553533]A new window opens with a host profile page for the IP address you selected. For more information on host attributes and host profiles, see Using Host Profiles.
 
      
       
       	 [bookmark: pgfId-1553726]If you selected a data point with a specific IP address and want to make a whois search on that address, select  Whois .
 
      
 
     
 
     [bookmark: pgfId-1554019]A new window opens with the results of a whois query for the IP address you selected.
 
      
       
       	 [bookmark: pgfId-1554145]If you selected a data point associated with a specific application and want more information about that application, select  View Application Information .
 
      
 
     
 
     [bookmark: pgfId-1554302]A new window opens with information on the application you selected. For more information about application attributes, see Understanding Application Detection.
 
      
       
       	 [bookmark: pgfId-1582001]If you selected a data point associated with a specific user and want more information about that user, select  View User Information .
 
      
 
     
 
     [bookmark: pgfId-1582151]A new window opens with a user profile page for the user you selected. For more information on user details, see Understanding User Details and Host History.
 
      
       
       	 [bookmark: pgfId-1582361]If you selected a data point associated with a specific intrusion event message and want more information about the associated intrusion rule, select  View Rule Documentation .
 
      
 
     
 
     [bookmark: pgfId-1582602]A new window opens with a rule details page relevant to the event you selected. For more information on intrusion rule details, see Viewing Rule Details.
 
      
       
       	 [bookmark: pgfId-1584654]If you selected a data point associated with a specific IP address and want to add that IP address to the Security Intelligence global blacklist or whitelist, select the appropriate option:  Blacklist Now or  Whitelist Now . Confirm your choice in the pop-up window that appears.
 
      
 
     
 
     [bookmark: pgfId-1590338]The IP address is blacklisted or whitelisted. For more information, see Working with the Global Whitelist and Blacklist.
 
     [bookmark: pgfId-1631341]These options are not listed on the DC500 Defense Center, which does not support Security Intelligence data.
 
     [bookmark: pgfId-1696199]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1590349][bookmark: 47927]Working [bookmark: marker-1590343]with Filters in the Context Explorer
 
    [bookmark: pgfId-1590612]License: FireSIGHT
 
    [bookmark: pgfId-1556181]Beyond the basic, wide-ranging data that the Context Explorer initially displays, you have the option to filter that data for a more granular contextual picture of activity on your network. Filters encompass all types of FireSIGHT data except URL information, support exclusion as well as inclusion, can be applied quickly by clicking on Context Explorer graph data points, and affect the entire explorer. You can apply up to 20 filters at once to create a highly specific portrait tailored to the needs of your network and organization. Filters that you apply are reflected in the Context Explorer URL so you can bookmark useful filter sets in your browser program for later use.
 
    [bookmark: pgfId-1554800]For information on using filters in the Context Explorer, see the following topics:
 
     
     	 [bookmark: pgfId-1556475]Adding and Applying Filters
 
     	 [bookmark: pgfId-1556666]Creating Filters with the Context Menu
 
     	 [bookmark: pgfId-1556736]Bookmarking Filters
 
    
 
     
      [bookmark: pgfId-1525618][bookmark: 47234]Add[bookmark: marker-1576393]ing and App[bookmark: marker-1575845]lyin[bookmark: marker-1576398]g Filters
 
     [bookmark: pgfId-1550626]License: feature dependent
 
     [bookmark: pgfId-1631735]Supported Devices: feature dependent
 
     [bookmark: pgfId-1631766]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-1556892]You can add filters to Context Explorer data in several ways: 
 
      
      	 [bookmark: pgfId-1557079]from the Add Filter window
 
      	 [bookmark: pgfId-1557115]from the context menu pop-up window, when you select a data point in the explorer
 
      	 [bookmark: pgfId-1557261]from the Context Explorer icon (
 
      [image: ] ) or from text links that appear in certain detail view pages (Application Detail, Host Profile, Rule Detail, and User Profile). Clicking these links automatically opens and filters the Context Explorer according to the relevant data on the detail view page. For example, clicking the Context Explorer link on a user detail page for the user 
       jenkins constrains the explorer to show only data associated with that user 
     
 
     [bookmark: pgfId-1558143]This section focuses on creating filters from scratch with the Add Filter window. For information on using the context menu to create quick filters from Context Explorer graph and list data, see Creating Filters with the Context Menu.
 . 
     
 
     [bookmark: pgfId-1563597]The Data Type drop-down list contains many different types of FireSIGHT System data you can use to constrain the Context Explorer. After you select a data type, you then enter a specific value for that type in the Filter field (for example, a value of Asia for the type Continent). To assist you, the Filter field presents several grayed-out example values for the data type you select. (These are erased when you enter data in the field.)
 
     [bookmark: pgfId-1719899]Th[bookmark: marker-1719898]e following table lists the data types available as filters, with examples and brief definitions of each. Note that The DC500 Defense Center does not display and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect data for features they do not support. See the Supported Access Control Capabilities by Device Model table for a summary of Series 2 device and Cisco NGIPS for Blue Coat X-Series features.
 
     [bookmark: pgfId-1720140]
 
      
       
        
        [bookmark: pgfId-1719924]Table 56-2 [bookmark: 32803]Filter Data Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-1719930]Type 
          
  
         	 
           
           [bookmark: pgfId-1719932]Example Values 
          
  
         	 
           
           [bookmark: pgfId-1719934]Definition 
          
  
        
 
         
         	[bookmark: pgfId-1719936]Access Control Action
  
         	[bookmark: pgfId-1719938]Allow, Block
  
         	[bookmark: pgfId-1719940]Action taken by your access control policy to allow or block traffic
  
        
 
         
         	[bookmark: pgfId-1719942]Application Category
  
         	[bookmark: pgfId-1719944]web browser, email
  
         	[bookmark: pgfId-1719946]General classification of an application’s most essential function
  
        
 
         
         	[bookmark: pgfId-1719948]Application Name
  
         	[bookmark: pgfId-1719950]Facebook, HTTP
  
         	[bookmark: pgfId-1719952]Name of an application
  
        
 
         
         	[bookmark: pgfId-1719954]Application Risk
  
         	[bookmark: pgfId-1719956]Very High, Medium
  
         	[bookmark: pgfId-1719958]Estimated security risk of an application
  
        
 
         
         	[bookmark: pgfId-1719960]Application Tag
  
         	[bookmark: pgfId-1719962]encrypts communications, sends mail
  
         	[bookmark: pgfId-1719964]Additional information about an application; applications can have any number of tags, including none
  
        
 
         
         	[bookmark: pgfId-1719966]Application Type
  
         	[bookmark: pgfId-1719968]Client, Web Application
  
         	[bookmark: pgfId-1719970]Type of an application: application protocol, client, or web application
  
        
 
         
         	[bookmark: pgfId-1719972]Business Relevance
  
         	[bookmark: pgfId-1719974]Very Low, High
  
         	[bookmark: pgfId-1719976]Estimated relevance of an application to business activity (as opposed to recreation)
  
        
 
         
         	[bookmark: pgfId-1719978]Continent
  
         	[bookmark: pgfId-1719980]North America, Asia
  
         	[bookmark: pgfId-1719982]Continent associated with a routable IP address detected on your monitored network
  
        
 
         
         	[bookmark: pgfId-1719984]Country
  
         	[bookmark: pgfId-1719986]Canada, Japan
  
         	[bookmark: pgfId-1719988]Country associated with a routable IP address detected on your monitored network
  
        
 
         
         	[bookmark: pgfId-1719990]Device
  
         	[bookmark: pgfId-1719992]device1.example.com, 192.168.1.3
  
         	[bookmark: pgfId-1719994]Name or IP address of a device on your monitored network
  
        
 
         
         	[bookmark: pgfId-1719996]Event Classification
  
         	[bookmark: pgfId-1719998]Potential Corporate Policy Violation, Attempted Denial of Service
  
         	[bookmark: pgfId-1720000]Capsule description of an intrusion event, determined by the classification of the rule, decoder, or preprocessor that triggered it
  
        
 
         
         	[bookmark: pgfId-1720002]Event Message
  
         	[bookmark: pgfId-1720004]dns response, P2P
  
         	[bookmark: pgfId-1720006]Message generated by an event, determined by the rule, decoder, or preprocessor that triggered it
  
        
 
         
         	[bookmark: pgfId-1720008]File Disposition
  
         	[bookmark: pgfId-1720010]Malware, Clean
  
         	[bookmark: pgfId-1720012]Cloud-determined disposition of a file for which the Defense Center performed a malware cloud lookup
  
        
 
         
         	[bookmark: pgfId-1720017]File Name
  
         	[bookmark: pgfId-1720019]Packages.bz2
  
         	[bookmark: pgfId-1720021]Name of a file detected in network traffic
  
        
 
         
         	[bookmark: pgfId-1720023]File SHA256
  
         	[bookmark: pgfId-1720025]any 32-bit string
  
         	[bookmark: pgfId-1720029]SHA-256 hash value of a file for which the Defense Center performed a malware cloud lookup
  
        
 
         
         	[bookmark: pgfId-1720032]File Type
  
         	[bookmark: pgfId-1720034]GZ, SWF, MOV
  
         	[bookmark: pgfId-1720036]File type detected in network traffic
  
        
 
         
         	[bookmark: pgfId-1720038]File Type Category
  
         	[bookmark: pgfId-1720040]Archive, Multimedia, Executables
  
         	[bookmark: pgfId-1720042]General category of file type detected in network traffic
  
        
 
         
         	[bookmark: pgfId-1720044]IP Address
  
         	[bookmark: pgfId-1720046]192.168.1.3, 2001:0db8:85a3::0000/24
  
         	[bookmark: pgfId-1720048]IPv4 or IPv6 addresses, address ranges, or address blocks
 [bookmark: pgfId-1720049]Note that searching for an IP address returns events where that address was either the source or the destination for the event
  
        
 
         
         	[bookmark: pgfId-1720051]Impact Level
  
         	[bookmark: pgfId-1720053]Impact Level 1, Impact Level 2
  
         	[bookmark: pgfId-1720055]Estimated impact of an event on your monitored network
  
        
 
         
         	[bookmark: pgfId-1720057]Inline Result
  
         	[bookmark: pgfId-1720059]dropped, would have dropped
  
         	[bookmark: pgfId-1720061]Whether traffic was dropped, would have been dropped, or was not acted upon by the system
  
        
 
         
         	[bookmark: pgfId-1720063]IOC Category
  
         	[bookmark: pgfId-1720065]High Impact Attack, Malware Detected
  
         	[bookmark: pgfId-1720067]Category for a triggered Indication of Compromise (IOC) event
  
        
 
         
         	[bookmark: pgfId-1720069]IOC Event Type
  
         	[bookmark: pgfId-1720071]exploit-kit, malware-backdoor
  
         	[bookmark: pgfId-1720073]Identifier associated with a specific Indication of Compromise (IOC), referring to the event that triggers it
  
        
 
         
         	[bookmark: pgfId-1720075]Malware Threat Name
  
         	[bookmark: pgfId-1720077]W32.Trojan.a6b1
  
         	[bookmark: pgfId-1720079]The name of a malware threat
  
        
 
         
         	[bookmark: pgfId-1720081]OS Name
  
         	[bookmark: pgfId-1720083]Windows, Linux
  
         	[bookmark: pgfId-1720085]Name of an operating system
  
        
 
         
         	[bookmark: pgfId-1720087]OS Version
  
         	[bookmark: pgfId-1720089]XP, 2.6
  
         	[bookmark: pgfId-1720091]Specific version of an operating system
  
        
 
         
         	[bookmark: pgfId-1720093]Priority
  
         	[bookmark: pgfId-1720095]high, low
  
         	[bookmark: pgfId-1720097]Estimated urgency of an event
  
        
 
         
         	[bookmark: pgfId-1720099]Security Intelligence Category
  
         	[bookmark: pgfId-1720101]Malware, Spam
  
         	[bookmark: pgfId-1720103]Category of risky traffic, as determined by Security Intelligence
  
        
 
         
         	[bookmark: pgfId-1720105]Security Zone
  
         	[bookmark: pgfId-1720107]My Security Zone, Security Zone X
  
         	[bookmark: pgfId-1720109]A set of interfaces through which traffic is analyzed and, in an inline deployment, passes 
  
        
 
         
         	[bookmark: pgfId-1720111]SSL
  
         	[bookmark: pgfId-1720113]yes, no
  
         	[bookmark: pgfId-1720115]SSL- or TLS-encrypted traffic
  
        
 
         
         	[bookmark: pgfId-1720135]User
  
         	[bookmark: pgfId-1720137]wsmith, mtwain
  
         	[bookmark: pgfId-1720139]Identity of a user logged in to a host on your monitored network
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1563483]In the Filter field, you can input special search parameters such as * and ! essentially as you can in event searches. You can create exclusionary filters by prefixing filter parameters with the ! symbol. For more information on the search constraints typically supported by the FireSIGHT System, see Using Wildcards and Symbols in Searches.
 
     [bookmark: pgfId-1566911]When multiple filters are active, values for the same data type are treated as OR search criteria: all data that matches at least one of the values appears. Values for different data types are treated as AND search criteria: to appear, data must match at least one value for each filtered data type. For example, data that appears for the filter set of Application: 2channel, Application: Reddit, and User: edickinson must be associated with the user edickinson AND either the application 2channel OR the application Reddit.
 
     [bookmark: pgfId-1563892]After you confirm a data type and value for your filter, a filter widget appears at the top left of the page, displaying the new filter’s data type and value. 
 button. 
     
 
     [bookmark: pgfId-1642556]Note that some filter types are incompatible with others: for example, filters that relate to intrusion events (such as Device and Inline Result) cannot be applied at the same time as connection event-related filters (such as Access Control Action) because the system cannot sort connection event data by intrusion event data. The system automatically prevents incompatible filters from simultaneously applying; when one filter type is more recently activated, filters of the incompatible type are hidden as long as the incompatibility exists.
 
     [bookmark: pgfId-1637658]Note that the data displayed depends on such factors as how you license and deploy your managed devices, whether you configure features that provide the data and, in the case of Series 2 appliances, whether the appliance supports a feature that provides the data. For example, because neither the DC500 Defense Center nor Series 2 devices support URL filtering by category and reputation, the DC500 Defense Center does not display data for this feature and Series 2 devices do not detect this data.
 
     [bookmark: pgfId-1570734]To create a new filter from the Add Filter window:
 
     [bookmark: pgfId-1570813]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1570855]Step 1 Select Analysis > Context Explorer.
 
     [bookmark: pgfId-1570859]The Context Explorer appears.
 ). 
     
 
     [bookmark: pgfId-1571041]The Add Filter pop-up window appears.
 
     [bookmark: pgfId-1571095]Step 3 From the Data Type drop-down list, select the data type you want to filter on.
 
     [bookmark: pgfId-1571198]The Filter field populates with example values for that data type.
 
     [bookmark: pgfId-1571274]Step 4 In the Filter field, type the data type value you want to filter on.
 
     [bookmark: pgfId-1571362]Step 5 Click OK.
 
     [bookmark: pgfId-1571378]Your filter is added. The Context Explorer reappears and a corresponding filter widget appears.
 
     [bookmark: pgfId-1571635]Step 6 Optionally, repeat the previous steps to add more filters until you have the filter set you need. Note that because the Context Explorer does not automatically refresh, your filters are not applied when you add them.
 
     [bookmark: pgfId-1571801]Step 7 Click Apply Filters.
 
     [bookmark: pgfId-1571846]Your filters are applied and the Context Explorer refreshes to reflect the filtered data.
 
     [bookmark: pgfId-1696252]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1571936]To [bookmark: marker-1586411]delete a filter:
 
     [bookmark: pgfId-1571960]Access: Admin/Any Security Analyst
 
     
 ) on any filter widget. 
     
 
     [bookmark: pgfId-1572084]The filter is deleted.
 
     [bookmark: pgfId-1696234]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1579083]To clear all filters:
 
     [bookmark: pgfId-1579129]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1579485]Step 1 Click the Clear button that appears to the right of the filter widgets.
 
     [bookmark: pgfId-1579536]All filters are cleared.
 
     [bookmark: pgfId-1579683]Note that this button does not appear if no filters have been created.
 
     [bookmark: pgfId-1696217]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1579472][bookmark: 28913]Creating Filters with the Cont[bookmark: marker-1579471]ext Menu
 
     [bookmark: pgfId-1563487]License: FireSIGHT
 
     [bookmark: pgfId-1566720]While exploring Context Explorer graph and list data, you can click on data points, then use the context menu to quickly create a filter based on that data, either inclusive or exclusive. If you use the context menu to filter on information of data type Application, User, or Intrusion Event Message, or any individual host, the filter widget includes a widget information icon that links to the relevant detail page for that data type (such as Application Detail for application data). Note that you cannot filter on URL data.
 
     [bookmark: pgfId-1568268]You can also use the context menu to investigate specific graph or list data in more detail. For information, see Drilling Down on Context Explorer Data.
 
     [bookmark: pgfId-1567812]To create a filter from the context menu:
 
     [bookmark: pgfId-1567857]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1567885]Step 1 Select Analysis > Context Explorer.
 
     [bookmark: pgfId-1567920]The Context Explorer appears.
 
     [bookmark: pgfId-1567950]Step 2 In any explorer section except Traffic and Intrusion Events over Time or sections that contain URL data, click a data point you want to filter on.
 
     [bookmark: pgfId-1568220]The context menu pop-up window appears nearby.
 
     [bookmark: pgfId-1568201]Step 3 You have two options:
 
      
       
       	 [bookmark: pgfId-1568416]To add a filter for this data, click  Add Filter .
 
      
 
     
 
     [bookmark: pgfId-1569242]The filter is added and its widget appears at upper left.
 
      
       
       	 [bookmark: pgfId-1568487]To add an exclusion filter for this data, click  Add Exclude Filter . The filter, when applied, displays all data  not associated with the excluded value.
 
      
 
     
 
     [bookmark: pgfId-1569330]The filter is added and its widget appears at upper left. Exclude filters display an exclamation point before the filter value.
 
     [bookmark: pgfId-1696270]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1569420]To view filter detail:
 
     [bookmark: pgfId-1569459]Access: Admin/Any Security Analyst
 
     
 ) on any eligible filter widget. 
     
 
     [bookmark: pgfId-1569544]A new window opens with the detail page relevant to the filter’s data type.
 
     [bookmark: pgfId-1696288]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1568203][bookmark: 97289]Bookm[bookmark: marker-1575895]arking Filters
 
     [bookmark: pgfId-1550646]License: FireSIGHT
 
     [bookmark: pgfId-1570666]Filters function as a simple, agile tool to get the precise FireSIGHT data context you need at any given time. They are not intended as permanent configuration settings, and disappear when you navigate away from the Context Explorer or end your session. However, your organization may use certain filter combinations frequently. To preserve filter settings for later use, you can create a browser bookmark of the Context Explorer with your preferred filters applied. Because applied filters are incorporated in the Context Explorer page URL, loading a bookmark of that page also loads the corresponding filters.
 
     [bookmark: pgfId-1566604]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1886254][bookmark: 95080]Working with Re[bookmark: marker-1952512]ports 
      
      
 
     
 
 
    [bookmark: pgfId-1980346]The FireSIGHT System provides a flexible reporting system that allows you to quickly and easily generate multi-section reports with the event views or dashboards that appear on your Defense Center. You can also design your own custom reports from scratch. Reporting is available only on Defense Centers.
 
    [bookmark: pgfId-2151861]A report is a document file formatted in PDF, HTML, or CSV with the content you want to communicate. A report template specifies the data searches and formats for the report and its sections. The FireSIGHT System includes a powerful report designer that automates the design of report templates. You can replicate the content of any event view table or dashboard graphic displayed in the web interface.
 
    [bookmark: pgfId-2455367]You can build as many report templates as you need. Each report template defines the individual sections in the report and specifies the database search that creates the report’s content, as well as the presentation format (table, chart, detail view, and so on) and the time frame. Your template also specifies document attributes, such as the cover page and table of contents and whether the document pages have headers and footers (available only for reports in PDF format). You can export a report template in a single configuration package file and import it for reuse on another Defense Center.
 
    [bookmark: pgfId-2155008]You can include input parameters in a template to expand its usefulness. Input parameters allow you to produce tailored variations of the same report. When you generate a report with input parameters, the generation process prompts you to enter a value for each input parameter. The values you type constrain the report contents on a one-time basis. For example, you can place an input parameter in the destination IP field of the search that produces an intrusion event report; at report generation time, you can specify a department’s network segment when prompted for the destination IP address. The generated report then contains only information concerning that particular department.
 
    [bookmark: pgfId-2187275]See the following sections for more information on reports and report templates:
 
     
     	 [bookmark: pgfId-2532170]Understanding Report Templates
 
     	 [bookmark: pgfId-2187283]Creating and Editing Report Templates
 
     	 [bookmark: pgfId-2536393]Generating and Viewing Reports
 
     	 [bookmark: pgfId-2536384]Using Report Generation Options
 
     	 [bookmark: pgfId-2533874]Managing Report Templates and Report Files
 
    
 
   
 
    
     [bookmark: pgfId-2548555][bookmark: 29966]Understanding Report Templates
 
    [bookmark: pgfId-2548560]License: Any
 
    [bookmark: pgfId-2548564]The FireSIGHT System’s reporting feature allows you to quickly capture the content of any event view, dashboard, or workflow from your Defense Center and present it in report format. You use report templates to define the content and format of the data in each of the report’s sections, as well as the document attributes of the report file (cover page, table of contents, and page headers and footers). After you generate a report, the template stays available for reuse until you delete it.
 
    [bookmark: pgfId-2534151]Your reports contain one or more information sections. You choose the format (text, table, or chart) for each section individually. The format you select for a section may constrain the data that can be included. For example, you cannot show time-based information in certain tables using a pie chart format. You can change the data criteria or format of a section at any time to obtain optimum presentation.
 
    [bookmark: pgfId-2534152]You can base a report’s initial design on a predefined event view, or you can start your design by importing content from any defined dashboard, workflow, or summary. You can also start with an empty template shell, adding sections and defining their attributes one by one.
 
    [bookmark: pgfId-2534153]All sections in a report template have a title bar and various attribute fields that control the section’s contents and appearance. For more information, see the following:
 
     
     	 [bookmark: pgfId-2534157]the  Report Section Title Bar Elements  table
 
     	 [bookmark: pgfId-2534161]the  Report Section Fields  table
 
    
 
     
     
 
     
 
     
 
      
       
       [bookmark: pgfId-2534169]Table 57-1 [bookmark: 13298]Report Section Title Bar Elements 
 
       
       
        
        	 
          
          [bookmark: pgfId-2534173]Attribute 
         
  
        	 
          
          [bookmark: pgfId-2534175]Definition 
         
  
       
 
        
        	[bookmark: pgfId-2534177]section title
  
        	[bookmark: pgfId-2534179]Contains the name of the section as it appears in the report. Change it by clicking it and typing a new name. To avoid display issues, the system truncates long section title names when viewed on the Report Sections page.
  
       
 
        
        	[bookmark: pgfId-2534181]section title icons
  ) to add a duplicate of the section to the report template. ) to minimize the section. ) to delete the section, after confirmation. 
       
 
       
     
 
    
 
     
      
       
       [bookmark: pgfId-2534203]Table 57-2 [bookmark: 25896]Report Section Fields 
 
       
       
        
        	 
          
          [bookmark: pgfId-2534207]Field Name 
         
  
        	 
          
          [bookmark: pgfId-2534209]Definition 
         
  
       
 
        
        	[bookmark: pgfId-2534211]Table
  
        	[bookmark: pgfId-2534213]Presents a drop-down menu that allows you to select the table from which the section data is extracted.
  
       
 
        
        	[bookmark: pgfId-2534215]Preset
  
        	[bookmark: pgfId-2534217]Presents a drop-down menu of predefined searches. You can select an appropriate preset to initialize the search criteria when you define a new search.
  
       
 
        
        	[bookmark: pgfId-2534219]Format
  
        	[bookmark: pgfId-2534221]Presents icons that allow you to select the format of the section data. Options include:
 Bar chart: Compares quantities of the selected variables.
 Line chart: Shows trends/changes over time of a selected variable. Available only for time-based tables.
 .
 Table view: Shows values of attributes for each record. Not available for summary or statistical data.
 Detail view: Shows complex object data associated with certain events, such as packets (for intrusion events) and host profiles (for host events). Format is available only for certain event types that involve such objects. Output may degrade performance if large numbers are requested.
  
       
 
        
        	[bookmark: pgfId-2534243]Search or Filter
  
        	[bookmark: pgfId-2534245]Presents a drop-down menu of searches or application filters.
 ); see Working with Searches in Report Template Sections.
 [bookmark: pgfId-2534253]For the Application Statistics table, you use a user-defined application Filter to constrain a report; for information on creating filters, see Working with Application Filters.
  
       
 
        
        	[bookmark: pgfId-2534258]X-Axis
  
        	[bookmark: pgfId-2534260]Presents a drop-down menu of available data columns for the X-axis of the selected chart. Appears only when you select a chart format. For line charts, the X-axis value is always Time. For bar and pie charts, you cannot select Time as the X-axis value.
  
       
 
        
        	[bookmark: pgfId-2534262]Y-Axis
  
        	[bookmark: pgfId-2534264]Presents a drop-down menu of available data columns for the Y-axis of the selected chart.
  
       
 
        
        	[bookmark: pgfId-2534266]Section Description
  
        	[bookmark: pgfId-2534268]Defines the descriptive text that precedes the search data in the section. Enter a combination of text and input parameters. Default for a new section is the following set of two input parameters: $<Time Window> and $<Constraints>.
 [bookmark: pgfId-2534272]For more information on input parameters, see Using Input Parameters.
  
       
 
        
        	[bookmark: pgfId-2534274]Time Window
  
        	[bookmark: pgfId-2534276]Defines the time window for the data that appears in the section. If the section searches time-based tables, you can select the check box to inherit the report’s global time window. Alternatively, you can set a specific time window for the section. For information about setting the time window, see Editing the Sections of a Report Template.
  
       
 
        
        	[bookmark: pgfId-2534281]Results
  
        	[bookmark: pgfId-2534283]Select either Top or Bottom and enter the maximum number of records to be included in the section.
  
       
 
        
        	[bookmark: pgfId-2534285]Color
  
        	[bookmark: pgfId-2534287]Defines the colors for graphed data in the section. Select one or more colors, as applicable.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-2548532]Creating and Editing [bookmark: 60738]Rep[bookmark: marker-2548531]ort Templates
 
    [bookmark: pgfId-2548537]License: Any
 
    [bookmark: pgfId-2436416]You can build a new report template in any of the following ways:
 
     
     	 [bookmark: pgfId-2171472]Creating a New Report Template
 
     	 [bookmark: pgfId-2547938]Creating a Report Template from an Existing Template
 
     	 [bookmark: pgfId-2252826]Creating a Report Template from an Event View
 
     	 [bookmark: pgfId-2085025]Creating a Report Template by Importing a Dashboard or Workflow
 
    
 
    [bookmark: pgfId-2210574]To modify and customize a report template, see the following sections:
 
     
     	 [bookmark: pgfId-2538034]Editing the Sections of a Report Template
 
     	 [bookmark: pgfId-2538035]Working with Searches in Report Template Sections
 
     	 [bookmark: pgfId-2538079]Using Input Parameters
 
     	 [bookmark: pgfId-2210976]Editing Document Attributes in a Report Template
 
     	 [bookmark: pgfId-2210861]Customizing a Cover Page
 
     	 [bookmark: pgfId-2537897]Managing Logos
 
    
 
     
      [bookmark: pgfId-2539437][bookmark: 33385]Creating a [bookmark: marker-2539435]New Report Template
 
     [bookmark: pgfId-2539441]License: Any
 
     [bookmark: pgfId-2539443]If you do not want to copy an existing report template, you can create an entirely new template. First, you create a default template shell. Then, in the order you prefer, you design the individual template sections and set attributes for the report document. For information on these steps, see the following sections:
 
      
      	 [bookmark: pgfId-2539447]Creating a Template Shell
 
      	 [bookmark: pgfId-2539451]Configuring the Content of the Template Sections
 
      	 [bookmark: pgfId-2539455]Setting Attributes for PDF and HTML Report Documents
 
     
 
    
 
     
      [bookmark: pgfId-2539457][bookmark: 73763]Creating a Template Shell
 
     [bookmark: pgfId-2539461]License: Any
 
     [bookmark: pgfId-2539462]A report template is a framework of sections, each independently built from its own database query. The first step in creating a template is to generate the framework shell that allows you to add and format the sections.
 
     [bookmark: pgfId-2539463]To create a template shell:
 
     [bookmark: pgfId-2539467]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2539468]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2539469]Step 2 Click the Report Templates tab.
 
     [bookmark: pgfId-2539470]The Report Templates page appears.
 
     [bookmark: pgfId-2539471]Step 3 Click Create Report Template.
 
     [bookmark: pgfId-2539472]The Report Sections page appears with the default template name, New Report, in the Report Title field.
 
     [bookmark: pgfId-2539473]Step 4 Optionally, type a name for your new template in the Report Title field and click Save. The report title can contain any combination of alphanumeric characters and spaces.
 
     [bookmark: pgfId-2539474]An entry with the new template name appears on the Report Templates page list.
 ). 
     
 
     [bookmark: pgfId-2539482]The added input parameters appear in the Report Title field. For information on input parameters, see Using Input Parameters.
 
     [bookmark: pgfId-2539483]Step 6 Use the set of add icons under the Report Sections title bar to insert section shells as necessary. For information on section formatting, see the Report Section Fields table.
 
     [bookmark: pgfId-2555688]Each added section appears at the bottom of the template. Drag it to the correct location.
 
     [bookmark: pgfId-2555689]Step 7 Click the section title on the section title bar and type a name for the section (using a maximum of 120 characters).
 
     [bookmark: pgfId-2555685]Step 8 Click Save to save the template.
 
     [bookmark: pgfId-2539490]Your template is saved.
 
     [bookmark: pgfId-2539491]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2539493][bookmark: 95981]Configuring the Content of the Template Sections
 
     [bookmark: pgfId-2539497]License: Any
 
     [bookmark: pgfId-2539498]Each template section consists of a dataset generated by a search or filter, and has a format specification (table, pie chart, and so on) that determines the mode of presentation. You further determine section content by selecting the fields in the data records you want to include in the output, as well as the time frame and number of records to show.
 
     [bookmark: pgfId-2539499]To configure report template sections:
 
     [bookmark: pgfId-2539503]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2539507]Step 1 Edit the section attributes as described in Editing the Sections of a Report Template.
 
     [bookmark: pgfId-2539508]Step 2 Optionally, click Preview at the bottom of the section window to view the column layout or graphic format you selected.
 
      
       
     
 
     
 
     [bookmark: pgfId-2539509]Note Use the section preview utility to check the column selection and output characteristics such as pie chart colors. It is not a reliable indicator of the correctness of your configured search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2539510]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2539512][bookmark: 78311]Setting Attributes for PDF and HTML Report Documents
 
     [bookmark: pgfId-2539516]License: Any
 
     [bookmark: pgfId-2539517]The report you generate from the template has several document attributes that span all sections and control features, such as the cover page, headers and footers, page numbering, and so on.
 
     [bookmark: pgfId-2539518]To set attributes for the report documents:
 
     [bookmark: pgfId-2539522]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2539523]Step 1 Select Overview > Reporting. 
 
     [bookmark: pgfId-2539524]Step 2 Click the Report Templates tab.
 
     [bookmark: pgfId-2539525]The Report Templates page appears.
 
     [bookmark: pgfId-2539526]Step 3 Click Edit for the report template you want to use to generate the report.
 
     [bookmark: pgfId-2539527]The Report Sections page for your template appears.
 
     [bookmark: pgfId-2539528]Step 4 Click Advanced.
 
     [bookmark: pgfId-2539529]The Advanced Settings pop-up window appears.
 
     [bookmark: pgfId-2539532]Step 5 For documents in PDF or HTML format, perform the tasks described in Editing Document Attributes in a Report Template.
 
     [bookmark: pgfId-2539534]If you selected CSV as your document format, you have no document attributes to set.
 
     [bookmark: pgfId-2539535]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2547481][bookmark: 79583]Creating a Report Template from an Existing Template
 
     [bookmark: pgfId-2547485]License: Any
 
     [bookmark: pgfId-2547486]If you identify a good model among your existing templates, you can copy the template and edit its attributes to create a new report template. Cisco also provides a set of predefined report templates, visible on the Reports Tab in the list of templates. For a description of their attributes, see Using Predefined Report Templates.
 
     [bookmark: pgfId-2547493]To create a report template from an existing template:
 
     [bookmark: pgfId-2547497]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2547498]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2547499]Step 2 Click the Report Templates tab.
 
     [bookmark: pgfId-2547505]The Report Templates page appears. For information about Cisco-provided report templates, see Using Predefined Report Templates.
 ) next to the report template you want to copy as a model. 
     
 
     [bookmark: pgfId-2547511]The copied template appears as a new report template.
 
     [bookmark: pgfId-2547512]Step 4 In the Report Title field, type a name for your new report template.
 
     [bookmark: pgfId-2547513]Step 5 Click Save.
 
     [bookmark: pgfId-2547514]The report template is saved and an entry for the new report template appears on the Report Templates page.
 
     [bookmark: pgfId-2547515]Step 6 Make changes to the template as needed.
 
     [bookmark: pgfId-2547516]For information on defining the sections of the template and the document attributes, see:
 
      
       
       	 [bookmark: pgfId-2547520]Editing the Sections of a Report Template
 
       	 [bookmark: pgfId-2547524]Editing Document Attributes in a Report Template
 
      
 
     
 
     [bookmark: pgfId-2547525]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2547527]Using [bookmark: 89636]Predefined Report Templates
 
     [bookmark: pgfId-2547531]License: Any
 
     [bookmark: pgfId-2547532]You can use the following predefined report templates as-is, edit them, or use them as the basis for your own templates:
 
      
      	 [bookmark: pgfId-2547536]Host Report: $<Host>
 
      	 [bookmark: pgfId-2547540]User Report: $<User>
 
      	 [bookmark: pgfId-2547544]Attack Report: Attack $<Attack SID>
 
      	 [bookmark: pgfId-2547548]Malware Report
 
      	 [bookmark: pgfId-2547552]FireSIGHT Report: $<Customer Name>
 
      	 [bookmark: pgfId-2547556]Files Report
 
     
 
     [bookmark: pgfId-2547558][bookmark: 64349]Host Report: $<Host>
 
     [bookmark: pgfId-2547559]The Host Report: $<Host> report template provides information about a specific host on the network. This report template contains the following sections:
 
      
      	 [bookmark: pgfId-2547560]Server Applications
 
      	 [bookmark: pgfId-2547561]Client Applications
 
      	 [bookmark: pgfId-2547562]Intrusion Events Originating from This Host
 
      	 [bookmark: pgfId-2547563]Intrusion Events Destined to This Host
 
      	 [bookmark: pgfId-2547564]Connections Originating from This Host
 
      	 [bookmark: pgfId-2547565]Connections Destined to This Host
 
      	 [bookmark: pgfId-2547566]Users of This Host
 
      	 [bookmark: pgfId-2547567]White List Violations by This Host
 
     
 
     [bookmark: pgfId-2547570][bookmark: 94313]User Report: $<User>
 
     [bookmark: pgfId-2547571]The User Report: $<User> report template provides information about a specific user on the network. This report template contains the following sections:
 
      
      	 [bookmark: pgfId-2547572]Client Applications Used by This User
 
      	 [bookmark: pgfId-2547573]Web Applications Used by This User
 
      	 [bookmark: pgfId-2547574]Application Protocols Used by This User
 
      	 [bookmark: pgfId-2547575]Comprehensive List of Applications Used by This User
 
      	 [bookmark: pgfId-2547576]Intrusion Events Originated By This User’s Machines
 
      	 [bookmark: pgfId-2547577]Intrusion Events Destined to This User’s Machines
 
      	 [bookmark: pgfId-2547578]Connections Originating from This User’s Machines
 
      	 [bookmark: pgfId-2547579]Connections Destined to This User’s Machines
 
      	 [bookmark: pgfId-2547580]Hosts for This User
 
     
 
     [bookmark: pgfId-2547582][bookmark: 88604]Attack Report: Attack $<Attack SID>
 
     [bookmark: pgfId-2547583]The Attack Report: Attack $<Attack SID> report template provides information about a specific attack on the network. This report template contains the following sections:
 
      
      	 [bookmark: pgfId-2547584]General Information About This Attack
 
      	 [bookmark: pgfId-2547585]Number of Attacks
 
      	 [bookmark: pgfId-2547586]Number of Machines Initiating Attack
 
      	 [bookmark: pgfId-2547587]Number of Machines Being Attacked
 
      	 [bookmark: pgfId-2547588]Sources of This Attack
 
      	 [bookmark: pgfId-2547589]Destinations of This Attack
 
      	 [bookmark: pgfId-2547590]Traffic Patterns of This Attack
 
     
 
     [bookmark: pgfId-2547592][bookmark: 64564]Malware Report
 
     [bookmark: pgfId-2547593]The Malware Report report template provides information about network and endpoint-based malware events. This report template contains the following sections:
 
      
      	 [bookmark: pgfId-2547594]Malware Threats
 
      	 [bookmark: pgfId-2547595]Threat Detections over Time
 
      	 [bookmark: pgfId-2547596]Application Protocols Transferring Malware
 
      	 [bookmark: pgfId-2547597]Hosts Receiving Malware
 
      	 [bookmark: pgfId-2547598]Hosts Sending Malware
 
      	 [bookmark: pgfId-2547599]Users Affected by Malware
 
      	 [bookmark: pgfId-2547600]Malware Intrusions
 
      	 [bookmark: pgfId-2547601]File Types Infected with Malware
 
      	 [bookmark: pgfId-2547602]Applications Introducing Malware
 
      	 [bookmark: pgfId-2547603]Table View of Malware Events
 
     
 
     [bookmark: pgfId-2547610]Note that neither Series 2 devices nor the DC500 Defense Center support network-based malware protection, which can affect the data detected and displayed. For example, a Series 3 Defense Center managing only Series 2 devices can display only endpoint-based malware events.
 
     [bookmark: pgfId-2547624][bookmark: 30376]FireSIGHT Report: $<Customer Name>
 
     [bookmark: pgfId-2547628]The FireSIGHT Report: $<Customer Name> report template provides overall information about an organization’s network. This report template contains the following sections:
 
      
      	 [bookmark: pgfId-2547629]Summary of Application Traffic by Risk
 
      	 [bookmark: pgfId-2547630]Risky Applications with Low Business Relevance
 
      	 [bookmark: pgfId-2547631]Users of Risky Applications
 
      	 [bookmark: pgfId-2547632]Anonymizers and Proxies
 
      	 [bookmark: pgfId-2547633]Typically High Bandwidth Applications
 
      	 [bookmark: pgfId-2547634]Applications by Total Bandwidth
 
      	 [bookmark: pgfId-2547635]Hosts Accessing Sensitive Network
 
      	 [bookmark: pgfId-2547636]Users Accessing Sensitive Network
 
      	 [bookmark: pgfId-2547637]Applications on Sensitive Network
 
      	 [bookmark: pgfId-2547638]Ports and Protocols Related to Sensitive Network
 
      	 [bookmark: pgfId-2547639]Hosts Visiting Malicious URLs
 
      	 [bookmark: pgfId-2547640]Users Visiting Malicious URLs
 
      	 [bookmark: pgfId-2547641]Granular Application Usage
 
      	 [bookmark: pgfId-2547642]Web Applications
 
      	 [bookmark: pgfId-2547643]Client Applications
 
      	 [bookmark: pgfId-2547644]Application Protocols
 
      	 [bookmark: pgfId-2547645]Web Browser Versions
 
      	 [bookmark: pgfId-2547646]Operating System Versions
 
      	 [bookmark: pgfId-2547647]Overall User Activity
 
      	 [bookmark: pgfId-2547648]Intrusion Events by Impact
 
      	 [bookmark: pgfId-2547649]Intrusion Events by Impact (After Blocking)
 
      	 [bookmark: pgfId-2547650]Intrusion Events by Application
 
      	 [bookmark: pgfId-2547651]Top Intrusion Events
 
      	 [bookmark: pgfId-2547652]Comprehensive Application List
 
     
 
     [bookmark: pgfId-2547654][bookmark: 13738]Files Report
 
     [bookmark: pgfId-2547655]The Files Report report template provides information about files detected in network traffic by managed devices. This report template contains the following sections:
 
      
      	 [bookmark: pgfId-2547656]File Transfers over Time
 
      	 [bookmark: pgfId-2547657]Application Protocols Used by File Transfers
 
      	 [bookmark: pgfId-2547658]File Dispositions
 
      	 [bookmark: pgfId-2547659]File Actions
 
      	 [bookmark: pgfId-2547660]Hosts Receiving Files
 
      	 [bookmark: pgfId-2547661]Hosts Sending Files
 
      	 [bookmark: pgfId-2547662]Users Transferring Files
 
      	 [bookmark: pgfId-2547663]File Categories
 
      	 [bookmark: pgfId-2547664]File Types
 
      	 [bookmark: pgfId-2547665]File Names
 
      	 [bookmark: pgfId-2547666]Table View of File Events
 
     
 
    
 
     
      [bookmark: pgfId-2536799][bookmark: 43352]Creating a Report Templ[bookmark: marker-2537676]ate from an Event View
 
     [bookmark: pgfId-2536803]License: Any
 
     [bookmark: pgfId-2536804]Before you generate a report, the reporting system creates a report template that you can modify to meet your needs. You can add additional sections, modify automatically included sections, and delete sections.
 
     [bookmark: pgfId-2536805]To create a report template from an event view:
 
     [bookmark: pgfId-2536809]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2536810]Step 1 Populate an event view with the events you want in the report. You can do this in various ways:
 
      
       
       	 [bookmark: pgfId-2536811]Use an event search to define the events you want to view. For details on using the event search, see Searching for Events.
 
       	 [bookmark: pgfId-2536815]Drill down through a workflow until you have the appropriate events in your event view. For details on workflows and how to constrain events within a workflow, see Understanding and Using Workflows.
 
      
 
     
 
     [bookmark: pgfId-2536819]Step 2 From the event view page, click Report Designer.
 
     [bookmark: pgfId-2536820]The Report Sections page appears with a section for each view in the captured workflow. 
 
     [bookmark: pgfId-2536821]Step 3 Optionally, type a new name in the Report Title field and click Save.
 ) in the section’s title bar, and confirm the deletion. 
     
 
     [bookmark: pgfId-2536826]The deleted sections disappear.
 
      
       
     
 
     
 
     [bookmark: pgfId-2536827]Note The last report section in some workflows contains detail views that show packets, host profiles, or vulnerabilities, depending on the workflow. Retrieving large numbers of events with these detail views when generating your report may affect performance of the Defense Center.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2536831]Step 5 Optionally, adjust the settings of the fields in your report sections.
 
     [bookmark: pgfId-2536834]For details on configuring the fields in a report section, see Editing the Sections of a Report Template.
 
      
       
     
 
     
 
     [bookmark: pgfId-2536836]Tip To view the current column layout or chart formatting for a section, click the section’s Preview link.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2536837]Step 6 Optionally, change the title of any section by clicking the section title in the title bar.
 
     [bookmark: pgfId-2536838]The Set Section Title pop-up window appears. Type the section title and click OK.
 ). 
     
 
     [bookmark: pgfId-2536843]A new page break object appears at the bottom of the template. Drag it in front of the section that should start the new page. For information on using page breaks, see Editing the Sections of a Report Template.
 ). 
     
 
     [bookmark: pgfId-2536851]A new text section appears at the bottom of the template. Drag it to the place where it should appear in the report template. For information about editing a text section, see Editing the Sections of a Report Template. 
 
      
       
     
 
     
 
     [bookmark: pgfId-2536855]Tip Text sections, which support rich text (bold, italics, variable font size, and so on) as well as imported images, are useful for introductions to your report or your report sections.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2536856]Step 9 Optionally, click Advanced Settings to add a cover page, table of contents, starting page number, or header and footer text. For more information, see Editing Document Attributes in a Report Template.
 
     [bookmark: pgfId-2536860]Step 10 When the report template is correct, click Save.
 
     [bookmark: pgfId-2536861]The report template is saved and an entry for the report template appears on the Report Templates page.
 
     [bookmark: pgfId-2537697]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2537699][bookmark: 18383]Creating a Report Template by Impo[bookmark: marker-2537710]rting a Dashboard or Workflow
 
     [bookmark: pgfId-2537703]License: Any
 
     [bookmark: pgfId-2536869]You can quickly create a new report by importing dashboards, workflows, and statistics summaries. The import creates a section for each widget graphic in your dashboard and each event view in your workflow. You can delete any unnecessary sections to focus on the most important information. The following table describes the import options.
 
     [bookmark: pgfId-2536900]
 
      
       
        
        [bookmark: pgfId-2536876]Table 57-3 [bookmark: 74350]Data Source Options on Import Report Sections Window 
 
        
        
         
         	 
           
           [bookmark: pgfId-2536880]Select this option... 
          
  
         	 
           
           [bookmark: pgfId-2536882]To import... 
          
  
        
 
         
         	[bookmark: pgfId-2536884]Import Dashboard
  
         	[bookmark: pgfId-2536886]any custom analysis widget on the selected dashboard.
  
        
 
         
         	[bookmark: pgfId-2536888]Import Workflow
  
         	[bookmark: pgfId-2536890]any predefined or custom workflow. 
 imports the views in the Traffic by Port workflow generated from the Connection Events table.  
        
 
         
         	[bookmark: pgfId-2536893]Import Summary Sections
  
         	[bookmark: pgfId-2536895]any of the following generic summaries:
 
           
           	 [bookmark: pgfId-2536896]Intrusion Detailed Summary
 
           	 [bookmark: pgfId-2536897]Intrusion Short Summary
 
           	 [bookmark: pgfId-2536898]Discovery Detailed Summary
 
           	 [bookmark: pgfId-2536899]Discovery Short Summary
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2536901]To create a report template from a dashboard, workflow, or statistics summary:
 
     [bookmark: pgfId-2536905]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2536906]Step 1 Identify the dashboard, workflow, or summary you want to replicate in your report.
 
     [bookmark: pgfId-2536907]Step 2 Select Overview > Reporting.
 
     [bookmark: pgfId-2536908]Step 3 Click the Report Templates tab.
 
     [bookmark: pgfId-2536909]The Report Templates page appears.
 
     [bookmark: pgfId-2536910]Step 4 Click Create Report Template.
 
     [bookmark: pgfId-2536911]The Report Sections page appears.
 
     [bookmark: pgfId-2536912]Step 5 Type a name for your new report template in the Report Title field.
 
     [bookmark: pgfId-2536913]Step 6 Click Save to save the report template under the new name.
 
     [bookmark: pgfId-2536914]The report template is saved and an entry for the report template appears on the Report Templates page.
 ). 
     
 
     [bookmark: pgfId-2536919]The Import Report Sections pop-up window appears. You can choose any of the data sources described in the Data Source Options on Import Report Sections Window table.
 
     [bookmark: pgfId-2536923]Step 8 Select a dashboard, workflow or summary from the drop-down menus.
 
     [bookmark: pgfId-2536924]Step 9 For the data sources you want to add, click Import.
 
     [bookmark: pgfId-2536925]The Report Sections page for your template reappears with a section for each element of the selected data source. For dashboards, each widget graphic will have its own section; for workflows, each event view will have its own section.
 
     [bookmark: pgfId-2536926]Step 10 Make changes to the content of your sections as needed. 
 
     [bookmark: pgfId-2536930]For information on editing a report template, see Editing the Sections of a Report Template.
 
      
       
     
 
     
 
     [bookmark: pgfId-2536931]Note The last report section in some workflows contains detail views that show packets, host profiles, or vulnerabilities, depending on the workflow. Retrieving large numbers of events with these detail views when generating your report may affect performance of the Defense Center.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2536935]Step 11 When the report template is correct, click Save.
 
     [bookmark: pgfId-2536936]The report template is saved and an entry for the report template appears on the Report Templates page.
 
     [bookmark: pgfId-2536937]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2544704][bookmark: 43787]Editing the Sections of a Report Template
 
     [bookmark: pgfId-2423040]License: Any
 
     [bookmark: pgfId-2185839]You can modify a variety of report section attributes to adjust the content of the section and its data presentation. For information, see the following sections:
 
      
      	 [bookmark: pgfId-2278371]Setting the Table and Data Format for a Template Section
 
      	 [bookmark: pgfId-2278377]Specifying the Search or Filter for a Template Section
 
      	 [bookmark: pgfId-2278738]Setting the Search Fields that Appear in Table Format Sections
 
      	 [bookmark: pgfId-2278776]Adding a Text Section to a Report Template
 
      	 [bookmark: pgfId-2278782]Adding a Page Break to a Report Template
 
      	 [bookmark: pgfId-2278789]Setting the Time Window for a Template and Its Sections
 
      	 [bookmark: pgfId-2278796]Renaming a Template Section
 
      	 [bookmark: pgfId-2278803]Previewing a Template Section
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-2358406]Note Security Analysts can edit only report templates they created.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2277559][bookmark: 42174]Setting the Table and Data Format for a Template Section
 
     [bookmark: pgfId-2278843]License: Any
 
     [bookmark: pgfId-2311360]Each section in a report template queries a database table to generate content for that section. Changing the section’s data format uses the same data query, but modifies the fields that appear in the section according to the analytical purpose of the format type. For example, the table view of intrusion events populates the section with a large number of data fields per event record, while a pie chart section shows the portion of all matching records that each selected attribute represents, with no details about individual events. Bar chart sections compare the total counts of matching records that have specific attributes. Line charts summarize changes in the matching records over time with respect to a single attribute. Line charts are available only for data that is time-based, not for information about hosts, users, third-party vulnerabilities, and so on.
 
     [bookmark: pgfId-2320731]For information on the different available formats, see the Report Section Fields table.
 
     [bookmark: pgfId-2321302]To select the table and output format for a template section:
 
     [bookmark: pgfId-2321303]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2321304]Step 1 Use the Table drop-down menu to select the table to query in this section.
 
     [bookmark: pgfId-2280809]Icons appear in the Format field for each of the output formats available for the selected table.
 
     [bookmark: pgfId-2218399]Step 2 Select the applicable output format icon for the section. For information about these formats, see the Report Section Title Bar Elements table.
 
     [bookmark: pgfId-2379079]The fields included in the output appear.
 field. 
     
 
     [bookmark: pgfId-2379084]The Search Editor pop-up window appears with options for constraining the search. For information on using this window, see Working with Searches in Report Template Sections.
 
     [bookmark: pgfId-2379088]Step 4 For graphic output formats (pie chart, bar chart, and so on), adjust the X-Axis and Y-Axis parameters using the drop-down menus.
 
     [bookmark: pgfId-2379185]When you select a value for the X-axis, only compatible values appear in the Y-axis drop-down menu, and vice versa.
 
     [bookmark: pgfId-2379205]Step 5 For table output, select the columns, order of appearance, and sort order in your output. For detailed information, see Setting the Search Fields that Appear in Table Format Sections.
 
     [bookmark: pgfId-2379186]Step 6 Click Save to save the template.
 
     [bookmark: pgfId-2440111]Your template is saved.
 
     [bookmark: pgfId-2511702]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2277596][bookmark: 54389]Specifying the Search or Filter for a Template Section
 
     [bookmark: pgfId-2321368]License: Any
 
     [bookmark: pgfId-2321402]The search or filter in a report section specifies the database query on which the section content is based. For most tables, you can constrain a report using a predefined or saved search, or you can create a new search on the fly:
 
      
      	 [bookmark: pgfId-2385719]Predefined searches serve as examples for searching certain event tables and can provide quick access to important information about your network that you may want to include in reports.
 
      	 [bookmark: pgfId-2385720]Saved event searches include all public event searches that you or others have created, plus all your saved private event searches. For information on defining, naming, and using saved event searches, see Searching for Events.
 
      	 [bookmark: pgfId-2385724]Saved searches for the current report template are accessible only in the report template itself. The search names of saved report template searches end with the string “Custom Search.” Users create these searches while designing reports.
 
     
 
     [bookmark: pgfId-2385708]For the Application Statistics table, you use a user-defined application filter to constrain a report; for information on creating filters, see Working with Application Filters.
 
     [bookmark: pgfId-2277591]To specify a search or filter for a template section:
 
     [bookmark: pgfId-2186897]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2365116]Step 1 Select the database table to query from the Table drop-down menu:
 
      
       
       	 [bookmark: pgfId-2385633]For most tables, the  Search drop-down list appears.
 
       	 [bookmark: pgfId-2385640]For the Application Statistics table, the  Filter drop-down list appears.
 
      
 
     
 
     [bookmark: pgfId-2365094]Step 2 Select the search or filter you want to use to constrain the report.
 ). For more information, see 
     Working with Searches in Report Template Sections. 
     
 
     [bookmark: pgfId-2511718]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2185907][bookmark: 58324]Setting the Search Fields that Appear in Table Format Sections
 
     [bookmark: pgfId-2329126]License: Any
 
     [bookmark: pgfId-2329163]If you include table data in a section, you can choose which fields in the data record to show. All fields in the table are available for inclusion or exclusion. You select fields that accomplish the purpose of the report, then order and sort them accordingly.
 
     [bookmark: pgfId-2277838]To add and delete the fields in a table format section:
 
     [bookmark: pgfId-2311619]Access: Admin/Any Security Analyst
 
     
 parameter. 
     
 
     [bookmark: pgfId-2311693]The Table Field Selector window appears.
 
     [bookmark: pgfId-2333659]Step 2 Optionally, add and delete fields, and drag the field icons into the column order you want.
 
     [bookmark: pgfId-2282901]Step 3 Optionally, change the sort order of any column. Use the drop-down lists on each field icon to set the sort order and priority.
 
     [bookmark: pgfId-2282903]Step 4 When the fields are in the right order and have the necessary sort characteristics, click OK.
 
     [bookmark: pgfId-2282904]The Report Sections page appears.
 
     [bookmark: pgfId-2511734]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2237982][bookmark: 97886]Adding a Text Section to a Report Template
 
     [bookmark: pgfId-2283103]License: Any
 
     [bookmark: pgfId-2283106]You can add text sections to your templates to provide custom text, such as an introduction, for the whole report or for individual sections. Text sections can have rich text with multiple font sizes and styles (bold, italic, and so on) as well as input parameters and imported images. For information on input parameters, see Using Input Parameters.
 
     [bookmark: pgfId-2277929]To add a text section to a report template:
 
     [bookmark: pgfId-2237983]Access: Admin/Any Security Analyst
 
     
 ). 
     
 
     [bookmark: pgfId-2237986]A text section appears at the bottom of the template.
 
     [bookmark: pgfId-2323925]Step 2 Drag the new text section to its intended position in the report template.
 
     [bookmark: pgfId-2238787]Step 3 Optionally, add page breaks before and after the text section. For information on page breaks, see Adding a Page Break to a Report Template. 
 
     [bookmark: pgfId-2239055]Step 4 Optionally, click the text section’s generic name in the title bar to type a new name.
 
     [bookmark: pgfId-2239176]Step 5 Add formatted text and images to the body of the text section. You can include input parameters that dynamically update when you generate the report.
 
     [bookmark: pgfId-2239422]Step 6 Click Save when finished.
 
     [bookmark: pgfId-2278010]Your template is saved.
 
     [bookmark: pgfId-2511792]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2324032][bookmark: 76925]Adding a Page Break to a Report Template
 
     [bookmark: pgfId-2422716]License: Any
 
     [bookmark: pgfId-2324034]You can add page breaks before or after any section in the template. This feature is particularly helpful for multi-section reports with text pages that introduce the various sections.
 
     [bookmark: pgfId-2278255]To add a page break:
 
     [bookmark: pgfId-2422695]Access: Admin/Any Security Analyst
 
     
 ). 
     
 
     [bookmark: pgfId-2283787]A page break appears at the bottom of the template.
 
     [bookmark: pgfId-2283860]Step 2 Drag the page break to its intended location, before or after a section.
 
     [bookmark: pgfId-2283943]Step 3 Repeat the process for all page breaks you add to the template.
 
     [bookmark: pgfId-2511804]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2278204][bookmark: 58827]Setting the Time Window for a Template and Its Sections
 
     [bookmark: pgfId-2284027]License: Any
 
     [bookmark: pgfId-2312065]A report template’s time window defines the template’s reporting period. Report templates with time-based data (such as intrusion or discovery events) have a global time window, which the time-based sections in the template inherit by default when created. Changing the global time window changes the local time window for the sections that are configured to inherit the global time window. You can disable time window inheritance for an individual section by clearing its Inherit Time Window check box. You can then edit the local time window.
 
      
       
     
 
     
 
     [bookmark: pgfId-2285063]Note Global time window inheritance applies only to report sections with data from time-based tables, such as intrusion events and discovery events. For sections that report on network assets (hosts and devices) and related information (such as vulnerabilities), you must set each time window individually.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2285531]To change a report template’s global time window:
 
     [bookmark: pgfId-2324172]Access: Admin/Any Security Analyst
 
     
 ) next to the report template you want to edit. 
     
 
     [bookmark: pgfId-2285536]The Report Sections page appears.
 
     [bookmark: pgfId-2324284]Step 2 Click Generate.
 
     [bookmark: pgfId-2324285]The Generate Report pop-up window appears.
 ). 
     
 
     [bookmark: pgfId-2286116]The Events Time Window page appears in a new window. For information about using this page, see Setting Event Time Constraints.
 
     [bookmark: pgfId-2286415]Step 4 When you are finished, click Apply on the Events Time Window.
 
     [bookmark: pgfId-2286544]The Generate Report pop-up window reappears with the new time window.
 
     [bookmark: pgfId-2312802]Step 5 Click Cancel to return to the Report Sections page, or OK to generate the report.
 
     [bookmark: pgfId-2286677]Your report can have different time ranges per section. For example, your first section could be a summary for the month, and the remaining sections could drill down into details at the week level. In such cases, you set the section-level time windows individually.
 
     [bookmark: pgfId-2511861]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2372211]To configure a section’s local time window:
 
     [bookmark: pgfId-2286678]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2287345]Step 1 On the Report Sections page of a template, clear the Inherit Time Window check box for the section if it is present.
 
     [bookmark: pgfId-2287346]The local section time window icon appears.
 ). 
     
 
     [bookmark: pgfId-2380598]The Events Time Window page appears. For information about using this page, see Setting Event Time Constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-2380602]Note Sections with data from statistics tables can have only sliding time windows.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2287650]Step 3 When you have set a new local time window, click Apply on the Events Time Window.
 
     [bookmark: pgfId-2287347]Step 4 Click Save.
 
     [bookmark: pgfId-2287348]The Report Sections page appears for further editing.
 
     [bookmark: pgfId-2511884]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2180496][bookmark: 80465]Renaming a Template Section
 
     [bookmark: pgfId-2287706]License: Any
 
     [bookmark: pgfId-2287721]When you create a new template, the sections you add receive generic section names and should be renamed to indicate their content.
 
     [bookmark: pgfId-2278078]To rename a template section:
 
     [bookmark: pgfId-2187078]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2221784]Step 1 Click the current section name in the section header.
 
     [bookmark: pgfId-2222553]The Set Section Title pop-up window appears.
 
     [bookmark: pgfId-2222605]Step 2 Type a new name for the section (using a maximum of 120 characters) and click OK.
 
     [bookmark: pgfId-2222730]The name in the section title bar is changed.
 
     [bookmark: pgfId-2511900]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2239520][bookmark: 97518]Previewing a Template Section
 
     [bookmark: pgfId-2287781]License: Any
 
     [bookmark: pgfId-2287784]The preview function shows the field layout and sort order for table views and important legibility characteristics of graphics, such as pie chart colors.
 
     [bookmark: pgfId-2278143]To preview a template section:
 
     [bookmark: pgfId-2239521]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2239522]Step 1 At any time while editing a section, click Preview for the section.
 
     [bookmark: pgfId-2239523]The Preview pop-up window appears.
 
     [bookmark: pgfId-2312618]Step 2 Close the preview by clicking OK at the bottom of the window.
 
     [bookmark: pgfId-2440674]The Report Sections page appears.
 
     [bookmark: pgfId-2511963]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2322310][bookmark: 87267]Working with Searches in Report Template Sections
 
     [bookmark: pgfId-2322311]License: Any
 
     [bookmark: pgfId-2322312]The key to generating successful reports is defining the searches that populate the report’s sections. The FireSIGHT System provides a search editor to view the searches available in your report templates and to define new custom searches.
 
      
       
     
 
     
 
     [bookmark: pgfId-2384075]Tip The custom searches you make in a report template are specific to the template where you create them. You can make searches that are reusable across all report templates in the event viewer. When you save a custom search in the event viewer, it appears in the Search drop-down menu of all report templates. For details on using the event viewer to create and save custom searches, see Searching for Events.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2384079]To create a custom search:
 
     [bookmark: pgfId-2322326]Access: Admin/Any Security Analyst
 
     
 field. 
     
 
     [bookmark: pgfId-2343248]The Search Editor page appears with the table to be searched selected.
 
     [bookmark: pgfId-2343094]Step 2 Optionally, from the Saved Searches drop-down menu, select a predefined search.
 
     [bookmark: pgfId-2322334]The drop-down presents all available predefined searches for this table, including system-wide and report-specific predefined searches.
 
     [bookmark: pgfId-2322345]Step 3 Edit the search criteria in the appropriate fields. For certain fields, your constraints can include the same operators (<, <>, and so on) as event searches. For the syntax of search criteria, see Searching for Events.
 
     [bookmark: pgfId-2322346]If you enter multiple criteria, the search returns only the records that match all the criteria. 
 ) appears, you can insert an input parameter from the drop-down menu instead of typing a constraint value. For information on using input parameters in report designs, see 
     Using Input Parameters. 
     
 
     [bookmark: pgfId-2322357]For some search fields, the drop-down menu may contain user-defined managed objects instead of, or with, input parameters. Managed objects, which have distinctive icons depending on their type, are system configuration variables you can use as values in constraining searches. However, they do not produce the generation-time query for user input that occurs with input parameters. For information on managed objects, see Managing Reusable Objects.
 
      
       
     
 
     
 
     [bookmark: pgfId-2322361]Note When you edit the constraints of a reporting search, the system saves your edited search under the following name: section custom search, where section is the name in the section title bar followed by the string custom search. To have meaningful names for your saved custom searches, be sure you change the section name before you save the edited search. You cannot rename a saved reporting search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2322362]Step 5 When finished modifying the fields in the search editor, click OK.
 
     [bookmark: pgfId-2345072]The Report Sections page reappears and a new predefined search appears in the section’s Search drop-down menu.
 
     [bookmark: pgfId-2512010]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2345083][bookmark: 66095]Using Input Par[bookmark: marker-2420354]ameters
 
     [bookmark: pgfId-2322490]License: Any
 ) indicates the fields that can process them. There are two kinds of input parameters: 
     
 
      
      	 [bookmark: pgfId-2322498]Predefined — see the  Predefined Input Parameters  table
 
      	 [bookmark: pgfId-2322502]User-defined — see  User-Defined Input Parameter Types  table
 
     
 
    
 
     
      [bookmark: pgfId-2322504][bookmark: 84418]Predefined Input Parameters
 
     [bookmark: pgfId-2422738]License: Any
 
     [bookmark: pgfId-2387859]Predefined input parameters are resolved by internal system functions or configuration information. For example, at report generation time, the system replaces the $<Time> parameter with the current date and time. The following table defines the parameters available for use. You might, for example, include $<Month> in the title of a monthly summary report that generates automatically under scheduler control. Your report title then automatically updates with the correct month.
 
     [bookmark: pgfId-2398316]
 
      
       
        
        [bookmark: pgfId-2398267]Table 57-4 [bookmark: 54036]Predefined Input Parameters 
 
        
        
         
         	 
           
           [bookmark: pgfId-2398271]Insert this parameter... 
          
  
         	 
           
           [bookmark: pgfId-2398273]...to include this information in your template: 
          
  
        
 
         
         	[bookmark: pgfId-2398275]$<Logo>
  
         	[bookmark: pgfId-2398277]The selected uploaded logo
  
        
 
         
         	[bookmark: pgfId-2398279]$<Report Title>
  
         	[bookmark: pgfId-2398281]The report title
  
        
 
         
         	[bookmark: pgfId-2398283]$<Time>
  
         	[bookmark: pgfId-2398285]The date and time of day the report ran, with one-second granularity
  
        
 
         
         	[bookmark: pgfId-2398287]$<Month>
  
         	[bookmark: pgfId-2398289]The current month
  
        
 
         
         	[bookmark: pgfId-2398291]$<Year>
  
         	[bookmark: pgfId-2398293]The current year
  
        
 
         
         	[bookmark: pgfId-2398295]$<System Name>
  
         	[bookmark: pgfId-2398300]The name of the Defense Center
  
        
 
         
         	[bookmark: pgfId-2398302]$<Model Number>
  
         	[bookmark: pgfId-2398307]The model number of the Defense Center
  
        
 
         
         	[bookmark: pgfId-2398309]$<Time Window>
  
         	[bookmark: pgfId-2398311]The time window currently applied to the report section
  
        
 
         
         	[bookmark: pgfId-2398313]$<Constraints>
  
         	[bookmark: pgfId-2398315]The search constraints currently applied to the report section
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2398903]The following table lists the valid input parameters that can be used in different areas within the Report Templates page.
 
     [bookmark: pgfId-2398904]
 
      
       
        
        [bookmark: pgfId-2512440]Table 57-5 [bookmark: 37040]Predefined Input Parameter Usage 
 
        
        
         
         	 
           
           [bookmark: pgfId-2512454]Parameter 
          
  
         	 
           
           [bookmark: pgfId-2512456]Report Template Cover Page 
          
  
         	 
           
           [bookmark: pgfId-2512458]Report Template Report Title 
          
  
         	 
           
           [bookmark: pgfId-2512460]Report Template Section Description 
          
  
         	 
           
           [bookmark: pgfId-2512462]Report Template Text Section 
          
  
         	 
           
           [bookmark: pgfId-2512464]Generate Report File Name 
          
  
         	 
           
           [bookmark: pgfId-2512466]Generate Report Email Subject, Body 
          
  
        
 
         
         	[bookmark: pgfId-2512468]$<Logo>
  
         	[bookmark: pgfId-2512470]yes
  
         	[bookmark: pgfId-2512472]no
  
         	[bookmark: pgfId-2512474]no
  
         	[bookmark: pgfId-2512476]no
  
         	[bookmark: pgfId-2512478]no
  
         	[bookmark: pgfId-2512480]no
  
        
 
         
         	[bookmark: pgfId-2512482]$<Report Title>
  
         	[bookmark: pgfId-2512484]yes
  
         	[bookmark: pgfId-2512486]no
  
         	[bookmark: pgfId-2512488]yes
  
         	[bookmark: pgfId-2512490]yes
  
         	[bookmark: pgfId-2512492]yes
  
         	[bookmark: pgfId-2512494]yes
  
        
 
         
         	[bookmark: pgfId-2512496]$<Time>
  
         	[bookmark: pgfId-2512498]yes
  
         	[bookmark: pgfId-2512500]yes
  
         	[bookmark: pgfId-2512502]yes
  
         	[bookmark: pgfId-2512504]yes
  
         	[bookmark: pgfId-2512506]yes
  
         	[bookmark: pgfId-2512508]yes
  
        
 
         
         	[bookmark: pgfId-2512510]$<Month>
  
         	[bookmark: pgfId-2512512]yes
  
         	[bookmark: pgfId-2512514]yes
  
         	[bookmark: pgfId-2512516]yes
  
         	[bookmark: pgfId-2512518]yes
  
         	[bookmark: pgfId-2512520]yes
  
         	[bookmark: pgfId-2512522]yes
  
        
 
         
         	[bookmark: pgfId-2512524]$<Year>
  
         	[bookmark: pgfId-2512526]yes
  
         	[bookmark: pgfId-2512528]yes
  
         	[bookmark: pgfId-2512530]yes
  
         	[bookmark: pgfId-2512532]yes
  
         	[bookmark: pgfId-2512534]yes
  
         	[bookmark: pgfId-2512536]yes
  
        
 
         
         	[bookmark: pgfId-2512538]$<System Name>
  
         	[bookmark: pgfId-2512540]yes
  
         	[bookmark: pgfId-2512542]yes
  
         	[bookmark: pgfId-2512544]yes
  
         	[bookmark: pgfId-2512546]yes
  
         	[bookmark: pgfId-2512548]yes
  
         	[bookmark: pgfId-2512550]yes
  
        
 
         
         	[bookmark: pgfId-2512552]$<Model Number>
  
         	[bookmark: pgfId-2512554]yes
  
         	[bookmark: pgfId-2512556]yes
  
         	[bookmark: pgfId-2512558]yes
  
         	[bookmark: pgfId-2512560]yes
  
         	[bookmark: pgfId-2512562]yes
  
         	[bookmark: pgfId-2512564]yes
  
        
 
         
         	[bookmark: pgfId-2512566]$<Time Window>
  
         	[bookmark: pgfId-2512568]no
  
         	[bookmark: pgfId-2512570]no
  
         	[bookmark: pgfId-2512572]yes
  
         	[bookmark: pgfId-2512574]no
  
         	[bookmark: pgfId-2512576]no
  
         	[bookmark: pgfId-2512578]no
  
        
 
         
         	[bookmark: pgfId-2512580]$<Constraints>
  
         	[bookmark: pgfId-2512582]no
  
         	[bookmark: pgfId-2512584]no
  
         	[bookmark: pgfId-2512586]yes
  
         	[bookmark: pgfId-2512588]no
  
         	[bookmark: pgfId-2512590]no
  
         	[bookmark: pgfId-2512592]no
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2398905]User-Defined Input Parameters
 
     [bookmark: pgfId-2422752]License: Any
 
     [bookmark: pgfId-2322551]You can create your own input parameters to supply as constraints in section searches. Constraining a search with an input parameter instructs the system to collect a value at generation time from the person who requests the report. In this way, you can dynamically tailor a report at generation time to show a particular subset of data without changing the template. For example, you can provide an input parameter for the Destination IP field of a report section’s search. Then, when you generate the report, you can type the IP network segment for a particular department to get data for that department only.
 
      
       
     
 
     
 
     [bookmark: pgfId-2322552]Tip You can also type * in an input parameter field, with the effect of ignoring the constraint.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2384165]You can also define string-type input parameters to add dynamic text in certain fields of your report, such as in emails (subject or body), report file names, and text sections. You can personalize reports for different departments, with customized report file names, email addresses, and email messages, using the same template for all.
 
     [bookmark: pgfId-2322556]Each input parameter you define has a name and a type. The following table describes the parameter types.
 
     [bookmark: pgfId-2322605]
 
      
       
        
        [bookmark: pgfId-2322564]Table 57-6 [bookmark: 46956]User-Defined Input Parameter Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-2322568]Use this parameter type... 
          
  
         	 
           
           [bookmark: pgfId-2322570]With fields with this data... 
          
  
        
 
         
         	[bookmark: pgfId-2322572]Network/IP
  
         	[bookmark: pgfId-2322574]any IP address or network segment in CIDR format
  
        
 
         
         	[bookmark: pgfId-2426892]Application
  
         	[bookmark: pgfId-2426894]name of an application protocol, client application, or web application
  
        
 
         
         	[bookmark: pgfId-2322576]Event Message
  
         	[bookmark: pgfId-2322578]any event view message
  
        
 
         
         	[bookmark: pgfId-2322584]Device
  
         	[bookmark: pgfId-2322592]3D appliance (Defense Center or FireSIGHT System managed device)
  
        
 
         
         	[bookmark: pgfId-2322598]Username
  
         	[bookmark: pgfId-2322600]user identification such as initiator user and responder user
  
        
 
         
         	[bookmark: pgfId-2427008]Number (VLAN ID, Snort ID, Vuln ID)
  
         	[bookmark: pgfId-2427010]any VLAN ID, Snort ID, or vulnerability ID
  
        
 
         
         	[bookmark: pgfId-2322602]String
  
         	[bookmark: pgfId-2322604]text fields such as application or OS version, notes, or descriptions
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2382077]An input parameter’s type determines the search fields where you can use it. You can use a given type only in appropriate fields, as described in the User-Defined Input Parameter Types table. For example, a user parameter you define as a string type is available for insertion in text fields but not in fields that take an IP address. 
 
     [bookmark: pgfId-2322615]To create user-defined input parameters for a report template:
 
     [bookmark: pgfId-2325075]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2322616]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2389598]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2389599]The Report Templates page appears.
 ) for the template you want to edit. 
     
 
     [bookmark: pgfId-2322622]The Report Sections page appears.
 
     [bookmark: pgfId-2322623]Step 4 Click Advanced.
 
     [bookmark: pgfId-2322624]The Advanced Settings pop-up window appears.
 ). 
     
 
     [bookmark: pgfId-2322626]The Add Input Parameter pop-up window appears.
 
     [bookmark: pgfId-2322627]Step 6 Type the parameter name in the Name field and use the Type drop-down menu to select the type, then click OK.
 
     [bookmark: pgfId-2322628]The new parameter appears in the Input Parameters menu.
 
     [bookmark: pgfId-2322629]Step 7 Repeat the steps above until you have defined all the parameters you need.
 
     [bookmark: pgfId-2327479]Step 8 Click OK.
 
     [bookmark: pgfId-2441127]Your new input parameters are saved for this template and the Report Sections page reappears.
 
     [bookmark: pgfId-2512628]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2512133]If you reuse a report template, you can change the name and type for any input parameters to better reflect the purpose of the new report.
 
     [bookmark: pgfId-2512134]To edit user-defined input parameters for a report template:
 
     [bookmark: pgfId-2512138]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2322631]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2327490]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2322632]The Report Templates page appears.
 ) for the template you want to edit. 
     
 
     [bookmark: pgfId-2322637]The Report Sections page appears.
 
     [bookmark: pgfId-2322638]Step 4 Click Advanced.
 
     [bookmark: pgfId-2322639]The Advanced Settings pop-up window appears. The Input Parameters section lists all available user-defined parameters for the report template.
 ). 
     
 
     [bookmark: pgfId-2322644]The Edit Input Parameter pop-up window appears.
 
     [bookmark: pgfId-2322645]Step 6 Change the parameter name in the Name field and the parameter type using the Type drop-down menu, then click OK.
 
     [bookmark: pgfId-2322646]The changed parameter appears in the Input Parameters section.
 
     [bookmark: pgfId-2322647]Step 7 Repeat the steps above until you have defined all the parameters you need. Click OK.
 
     [bookmark: pgfId-2441296]Your changes are saved and the Report Sections page reappears.
 
     [bookmark: pgfId-2512676]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2322648]To delete user-defined input parameters for a report template:
 
     [bookmark: pgfId-2422809]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2322649]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2327529]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2322650]The Report Templates page appears.
 ) for the template you want to edit. 
     
 
     [bookmark: pgfId-2322655]The Report Sections page appears.
 
     [bookmark: pgfId-2322656]Step 4 Click Advanced.
 
     [bookmark: pgfId-2389229]The Advanced Settings pop-up window appears. The Input Parameters section lists all available user-defined parameters for the report template.
 ) next to the input parameter and confirm. 
     
 
     [bookmark: pgfId-2441412]Step 6 Click OK.
 
     [bookmark: pgfId-2389234]The input parameter is deleted and the Report Sections page reappears.
 
     [bookmark: pgfId-2512690]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2384190]You use input parameters to expand the usefulness of your searches. The input parameter instructs the system to collect a value at generation time from the person who requests the report. In this way, you can dynamically constrain a report at generation time to show a particular subset of data without changing the search. For example, you can provide an input parameter for the Destination IP field of a report section that drills down on security events at a department level. When you generate the report, you can type the IP network segment for a particular department to get data for that department only.
 
     [bookmark: pgfId-2322663]To constrain the search in a report template with user-defined input parameters:
 
     [bookmark: pgfId-2422829]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2322664]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2327561]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2322665]The Report Templates page appears.
 ) for the template you want to edit. 
     
 
     [bookmark: pgfId-2322670]The Report Sections page appears.
 field within the section. 
     
 ). 
     
 ). 
     
 
     [bookmark: pgfId-2322680]The input parameter appears in the field.
 
      
       
     
 
     
 
     [bookmark: pgfId-2322681]Note Input parameters you define are available only for search fields that match their parameter type. For example, a parameter of type Network/IP is available only for fields that accept IP addresses or network segments in CIDR format.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2322682]Step 6 Click OK when you have added all necessary input parameters.
 
     [bookmark: pgfId-2322683]The Report Sections page appears with your changes.
 
     [bookmark: pgfId-2512704]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2180449][bookmark: 18096]Editing Document Attribut[bookmark: marker-2420378]es in a Report Template
 
     [bookmark: pgfId-2362218]License: Any
 
     [bookmark: pgfId-2288051]Before you generate your report, you can set document attributes that affect the report’s appearance. These attributes include the optional cover page and table of contents. Support for some attributes depends on the selected report format: PDF, HTML, or CSV. The following table provides further details on attribute support by format.
 
     [bookmark: pgfId-2288108]
 
      
       
        
        [bookmark: pgfId-2441742]Table 57-7 [bookmark: 29219]Document Attribute Support 
 
        
        
         
         	 
           
           [bookmark: pgfId-2441750]Attribute 
          
  
         	 
           
           [bookmark: pgfId-2441752]PDF Support? 
          
  
         	 
           
           [bookmark: pgfId-2441754]HTML Support? 
          
  
         	 
           
           [bookmark: pgfId-2441756]CSV Support? 
          
  
        
 
         
         	[bookmark: pgfId-2456079]Cover page
  
         	[bookmark: pgfId-2456081]yes, with optional logo and custom appearance 
  
         	[bookmark: pgfId-2456083]yes, with optional logo and custom appearance
  
         	[bookmark: pgfId-2456085]no
  
        
 
         
         	[bookmark: pgfId-2456087]Table of contents
  
         	[bookmark: pgfId-2456089]yes
  
         	[bookmark: pgfId-2456091]yes
  
         	[bookmark: pgfId-2456093]no
  
        
 
         
         	[bookmark: pgfId-2456095]Page headers and footers
  
         	[bookmark: pgfId-2456097]yes, with optional text or logo in any field
  
         	[bookmark: pgfId-2456099]no
  
         	[bookmark: pgfId-2456101]no
  
        
 
         
         	[bookmark: pgfId-2456103]Custom starting page number
  
         	[bookmark: pgfId-2456105]yes
  
         	[bookmark: pgfId-2456107]no
  
         	[bookmark: pgfId-2456109]no
  
        
 
         
         	[bookmark: pgfId-2456111]Option to suppress numbering of first page
  
         	[bookmark: pgfId-2456113]yes
  
         	[bookmark: pgfId-2456115]no
  
         	[bookmark: pgfId-2456117]no
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2187173]To set the document attributes for PDF and HTML reports:
 
     [bookmark: pgfId-2256201]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2389447]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2389448]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2389449]The Report Templates page appears.
 ) for the report template you want to edit. 
     
 
     [bookmark: pgfId-2389454]The Report Sections page appears.
 
     [bookmark: pgfId-2389509]Step 4 Click Advanced.
 
     [bookmark: pgfId-2389510]The Advanced Settings pop-up window appears.
 
     [bookmark: pgfId-2389511]Step 5 Select Include Cover Page to add a cover page.
 field to edit the cover page design. 
     
 
     [bookmark: pgfId-2556939]For more information, see Customizing a Cover Page.
 
     [bookmark: pgfId-2256265]Step 7 Select Include Table of Contents to add a table of contents.
 
     [bookmark: pgfId-2256367]Step 8 Configure the header and footer using the drop-downs of the three Header and Footer fields. You select header and footer content from the drop-down menus: logo, date, page number, and so on.
 
     [bookmark: pgfId-2258418]If you select Logo, the default logo image appears in the selected field. To change the default logo image, see Managing Logos.
 
     [bookmark: pgfId-2257583]Step 9 In the Page Number Start field, select the page number of the report’s first page.
 
     [bookmark: pgfId-2257960]Select Number First Page? to show the page number on the first page following the cover page. If selected, the cover page is not numbered.
 
     [bookmark: pgfId-2258102]Step 10 Click OK.
 
     [bookmark: pgfId-2258151]The document attributes are saved and the Report Sections page reappears.
 
     [bookmark: pgfId-2512736]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2395943][bookmark: 47358]Customizi[bookmark: marker-2420397]ng a Cover Page
 
     [bookmark: pgfId-2395987]License: Any
 
     [bookmark: pgfId-2425966]You can customize a report template’s cover page. Cover pages can have rich text with multiple font sizes and styles (bold, italic, and so on) as well as input parameters and imported images. For information on input parameters, see Using Input Parameters.
 
     [bookmark: pgfId-2396091]To customize a report template cover page:
 
     [bookmark: pgfId-2396144]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2396323]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2396324]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2396325]The Report Templates page appears and displays the list of templates.
 ) for a report template. 
     
 
     [bookmark: pgfId-2396330]The Report Sections page appears.
 
     [bookmark: pgfId-2396334]Step 4 Click Advanced.
 
     [bookmark: pgfId-2396335]The Advanced Settings pop-up window appears.
 . 
     
 
     [bookmark: pgfId-2397328]The Edit Cover Page window appears, displaying the default cover page design.
 
     [bookmark: pgfId-2396139]Step 6 Edit the cover page design within the rich text editor.
 
     [bookmark: pgfId-2396716]Step 7 Click OK.
 
     [bookmark: pgfId-2396752]The cover page design is saved and the Advanced Settings window reappears.
 
     [bookmark: pgfId-2512752]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2288248][bookmark: 88999]Mana[bookmark: marker-2420404]ging Logos
 
     [bookmark: pgfId-2288284]License: Any
 
     [bookmark: pgfId-2288292]You can store multiple logos on the Defense Center and associate them with different report templates. You set the logo association when you design the template. If you export the template, the export package contains the logo.
 
     [bookmark: pgfId-2293375]For information on where you can insert a logo in reports, see Editing Document Attributes in a Report Template.
 
     [bookmark: pgfId-2292968]See the following related procedures for more information:
 
      
      	 [bookmark: pgfId-2293006]Adding a New Logo
 
      	 [bookmark: pgfId-2293406]Changing the Logo for a Report Template
 
      	 [bookmark: pgfId-2369308]Deleting a Logo
 
     
 
    
 
     
      [bookmark: pgfId-2292937][bookmark: 38038]Adding a New Logo
 
     [bookmark: pgfId-2293051]License: Any
 
     [bookmark: pgfId-2295409]Logos uploaded to your Defense Center are available for all report templates on that Defense Center. Logo images must be in JPG format.
 
     [bookmark: pgfId-2293053]To add a logo to a Defense Center:
 
     [bookmark: pgfId-2293553]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2293556]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2325167]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2293663]The Report Templates page appears.
 ) for the report template you want to edit. 
     
 
     [bookmark: pgfId-2293798]The Report Sections page appears.
 
     [bookmark: pgfId-2293891]Step 4 Click Advanced.
 
     [bookmark: pgfId-2293914]The Advanced Settings pop-up window appears. The logo currently associated with the template appears under Logo in General Settings.
 ) for the logo. 
     
 
     [bookmark: pgfId-2391857]The Select Logo pop-up window appears with images of currently uploaded logos.
 
     [bookmark: pgfId-2294753]Step 6 Click Upload Logo.
 
     [bookmark: pgfId-2366950]The Upload Logo pop-up window appears.
 
     [bookmark: pgfId-2366940]Step 7 Select the logo file to upload by doing one of the following:
 
      
       
       	 [bookmark: pgfId-2367002]type the location of the logo file
 
       	 [bookmark: pgfId-2367005]click the  Browse button and browse to the file’s location
 
      
 
     
 
     [bookmark: pgfId-2294397]Step 8 Click Upload.
 
     [bookmark: pgfId-2294438]The image is uploaded to the Defense Center and appears in the Select Logo pop-up window.
 
     [bookmark: pgfId-2296036]Step 9 Optionally, associate the new logo with the current template by selecting it and clicking OK.
 
     [bookmark: pgfId-2296428]The Advanced Settings window reappears with the associated logo image.
 
     [bookmark: pgfId-2512780]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2297004][bookmark: 26169]Changing the Logo for a Report Template
 
     [bookmark: pgfId-2297005]License: Any
 
     [bookmark: pgfId-2368274]You can change the logo in a report to any JPG image uploaded to your Defense Center. For example, if you reuse a template, you can associate a logo for a different organization with the report.
 
     [bookmark: pgfId-2368284]To change the logo for a report template:
 
     [bookmark: pgfId-2325304]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2368314]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2368315]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2368316]The Report Templates page appears.
 ) for the report template you want to edit. 
     
 
     [bookmark: pgfId-2368321]The Report Sections page appears.
 
     [bookmark: pgfId-2368322]Step 4 Click Advanced.
 
     [bookmark: pgfId-2368323]The Advanced Settings pop-up window appears. The logo currently associated with the template appears under Logo in General Settings.
 ) for the logo. 
     
 
     [bookmark: pgfId-2368328]The Select Logo pop-up window appears with images of currently uploaded logos.
 
     [bookmark: pgfId-2368331]Step 6 Select the logo to associate with the report template.
 
     [bookmark: pgfId-2368486]The selected logo is highlighted.
 
     [bookmark: pgfId-2368339]Step 7 Click OK.
 
     [bookmark: pgfId-2368340]The Advanced Settings window reappears with the associated logo image.
 
     [bookmark: pgfId-2512818]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2368072][bookmark: 16358]Deleting a Logo
 
     [bookmark: pgfId-2368073]License: Any
 
     [bookmark: pgfId-2368074]You can delete logos from your Defense Center. Deleting a logo removes it from all templates where it is used. The deletion cannot be undone.
 
     [bookmark: pgfId-2442850]Note that you cannot delete the predefined Cisco logo.
 
     [bookmark: pgfId-2368084]To delete a logo from a Defense Center:
 
     [bookmark: pgfId-2368716]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2368784]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2368785]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2368786]The Report Templates page appears.
 ) for the report template you want to edit. 
     
 
     [bookmark: pgfId-2368791]The Report Sections page appears.
 
     [bookmark: pgfId-2368792]Step 4 Click Advanced.
 
     [bookmark: pgfId-2368793]The Advanced Settings pop-up window appears. The logo currently associated with the template appears under Logo in General Settings.
 ) for the logo. 
     
 
     [bookmark: pgfId-2368798]The Select Logo pop-up window appears with images of currently uploaded logos.
 
     [bookmark: pgfId-2368799]Step 6 Select the logo you want to delete.
 
     [bookmark: pgfId-2368800]The selected logo is highlighted.
 
     [bookmark: pgfId-2368801]Step 7 Click Delete Logo.
 
     [bookmark: pgfId-2368961]The deleted logo disappears from the Select Logo pop-up window.
 
     [bookmark: pgfId-2384365]Step 8 Click OK.
 
     [bookmark: pgfId-2384418]Your changes are saved and the Advanced Settings window reappears.
 
     [bookmark: pgfId-2537649]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2537653][bookmark: 29388]Generating and Viewing Repor[bookmark: CreateReport]ts
 
    [bookmark: pgfId-2537657]License: Any
 
    [bookmark: pgfId-2537635]After you create and customize your report template, you are ready to generate the report itself. The generation process lets you select the report’s format (HTML, PDF, or CSV). You can also adjust the report’s global time window, which applies a consistent time frame to all sections except those you exempt. For information on setting the report time window, see Setting the Time Window for a Template and Its Sections.
 
    [bookmark: pgfId-2536186]If the report template includes user input parameters in its search specification, the generation process prompts you to enter values, which tailor this run of the report to a subset of the data. For information on input parameters, see Using Input Parameters.
 
    [bookmark: pgfId-2536190]The Reports tab lists all previously generated reports, with report name, date and time of generation, generating user, and whether the report is stored locally or remotely. A status column indicates whether the report is already generated, is in the generation queue (for example, for scheduled tasks), or failed to generate (for example, due to lack of disk space).
 
    [bookmark: pgfId-2536191]The Reports tab page shows all locally stored reports. It shows remotely stored reports as well, if remote storage is currently configured. The location of your currently configured report storage appears at the bottom of the page, with disk usage for local, NFS, and SMB storage. If you access remote storage using SSH, disk usage data is not available. For information on setting up remote storage, see Using Remote Storage for Reports. 
 
     
      
    
 
    
 
    [bookmark: pgfId-2536195]Note If you store remotely and then switch back to local storage, the reports in remote storage do not appear on the Reports tab list. Similarly, if you switch from one remote storage location to another, the reports in the previous location do not appear in the list. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2536196]File names using Unicode (UTF-8) characters are not supported in PDF reports. If you generate a report in PDF format, any report sections that include special Unic ode file names (such as those appearing in file or malware events) display these file names in transliterated form.
 
    [bookmark: pgfId-2554949]If you have a DNS server configured and IP address resolution enabled, reports contain host names if resolution was successful. For more information, see Configuring Management Interfaces and Event Preferences.
 
    [bookmark: pgfId-2536197]Use the following procedures to generate and view reports. Note that users with Administrator access can view all reports; other users can view only the reports they generated. For information about managing your report files, see Downloading Reports and Deleting Reports.
 
    [bookmark: pgfId-2536204]To generate a report from a report template:
 
    [bookmark: pgfId-2536208]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2536209]Step 1 Select Overview > Reporting.
 
    [bookmark: pgfId-2536210]Step 2 Click the Report Templates tab.
 
    [bookmark: pgfId-2536211]The Report Templates page appears.
 ) for the template you want to use. 
    
 
    [bookmark: pgfId-2536216]The Generate Report pop-up dialog appears.
 ) to add one or more input parameters to the file name. For information on input parameters, see 
    Using Input Parameters. 
    
 
    [bookmark: pgfId-2536224]Step 5 Select the output format for the report by clicking the corresponding icon: HTML, PDF, or CSV.
 ). 
    
 
    [bookmark: pgfId-2536229]The Events Time Window pop-up window appears. For information on setting the events time window, see Setting Event Time Constraints.
 
     
      
    
 
    
 
    [bookmark: pgfId-2536233]Note Setting the global time window affects the content of individual report sections only if they are configured to inherit the global setting. For information on report section inheritance of the global time window, see Setting the Time Window for a Template and Its Sections.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2536237]Step 7 Type values for any fields that appear in the Input Parameters section.
 
     
      
    
 
    
 
    [bookmark: pgfId-2536238]Tip You can ignore user parameters by typing the * wildcard character in the field. This eliminates the user parameter’s constraint on the search.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2536239]Step 8 Optionally, if an email relay host is configured in your system policy, click Email to automate email delivery of the report when it generates. For details about email delivery features, see Distributing Reports by Email at Generation Time.
 
    [bookmark: pgfId-2536243]Step 9 Click OK and confirm when prompted.
 
    [bookmark: pgfId-2536244]The Report Generation Complete pop-up window appears with a link to view your report.
 
    [bookmark: pgfId-2536245]Step 10 Click either:
 
     
      
      	 [bookmark: pgfId-2536246]the report link, which opens a new window to display the report, or
 
      	 [bookmark: pgfId-2536247] OK to return to the Report Section page, where you can modify your report design.
 
     
 
    
 
    [bookmark: pgfId-2546058]You can review completed reports after initial generation, as well.
 
    [bookmark: pgfId-2546066]Step 11 Optionally, manage your report files. For more information, see Downloading Reports and Deleting Reports.
 
    [bookmark: pgfId-2536260]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2536261]To view a generated report:
 
    [bookmark: pgfId-2536265]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-2536266]Step 1 Select Overview > Reporting.
 
    [bookmark: pgfId-2536267]Step 2 Click the Reports tab.
 
    [bookmark: pgfId-2536268]The Reports page appears.
 
    [bookmark: pgfId-2536269]Step 3 Click the name of the report.
 
    [bookmark: pgfId-2536270]The default program on your local host opens the report in a new window.
 
    [bookmark: pgfId-2536271]Step 4 When finished viewing the document, use your browser to return to the Reports tab.
 
    [bookmark: pgfId-2536272]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2368894][bookmark: 39248]Using Report Gen[bookmark: marker-2420419]eration Options
 
    [bookmark: pgfId-2339998]License: Any
 
    [bookmark: pgfId-2340053]You have several additional options when generating reports. You can automatically schedule report generation, send reports via email, and store generated reports remotely. For more information, see the following sections:
 
     
     	 [bookmark: pgfId-2340102]Generating Reports Using the Scheduler
 
     	 [bookmark: pgfId-2340057]Distributing Reports by Email at Generation Time
 
     	 [bookmark: pgfId-2549103]Using Remote Storage for Reports
 
    
 
     
      [bookmark: pgfId-2549106][bookmark: 50469]Generating Rep[bookmark: marker-2549105]orts Using the Scheduler
 
     [bookmark: pgfId-2549110]License: Any
 
     [bookmark: pgfId-2340172]You can use the FireSIGHT System scheduler to automate report generation. You can customize the schedule on a full range of time frames such as daily, weekly, monthly, and so on. For more information, see Automating Report Generation.
 
     [bookmark: pgfId-2537771]If you also want to distribute email reports using the scheduler, you must configure your report template and a mail relay host before scheduling the task. For more information, see Distributing Reports by Email at Generation Time and Configuring a Mail Relay Host and Notification Address.
 
    
 
     
      [bookmark: pgfId-2340177][bookmark: 11499]Distributing Rep[bookmark: marker-2420435]orts by Email at Generation Time
 
     [bookmark: pgfId-2340178]License: Any
 
     [bookmark: pgfId-2340180]When you generate a report from its template, you can choose to automatically send the report as an email attachment to a list of recipients.
 
      
       
     
 
     
 
     [bookmark: pgfId-2387544]Note You must have a properly configured mail relay host to deliver a report by email. If you have not previously set up a mail host, see Configuring a Mail Relay Host and Notification Address. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2340186][bookmark: 43140]To email a report at generation time:
 
     [bookmark: pgfId-2422918]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2340187]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2340188]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2340189]The Report Templates page appears.
 ) for the template you want to generate from. 
     
 
     [bookmark: pgfId-2340191]The Generate Report pop-up window appears.
 
     [bookmark: pgfId-2340192]Step 4 Expand the Email section of the window.
 
     [bookmark: pgfId-2340197]Step 5 In the Email Options field, select Send Email.
 
     [bookmark: pgfId-2340198]Step 6 In the Recipient List, CC, and BCC fields, type recipients’ email addresses in comma-separated lists.
 
     [bookmark: pgfId-2340199]Step 7 In the Subject field, type a subject for your email.
 
      
       
     
 
     
 
     [bookmark: pgfId-2340200]Tip You can provide input parameters in the Subject field and the message body to dynamically generate information in the email, such as a timestamp or the name of the Defense Center. For further information, see Using Input Parameters.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2340207]Step 8 Type a cover letter in the email body as necessary. The available rich text features include a wide range of fonts, numbered and bullet lists, and so on.
 
     [bookmark: pgfId-2375602]Step 9 When all fields in the Generate Report window are correct, click OK and confirm.
 
     [bookmark: pgfId-2383204]The system distributes the generated report by email. You can configure the email’s From address under Email Notification in the system policy. For more information, see Managing System Policies.
 
     [bookmark: pgfId-2512877]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2383211][bookmark: 34571][bookmark: 44896]Using [bookmark: marker-2383210]Remote Storage for Reports
 
     [bookmark: pgfId-2444317]License: Any
 
     [bookmark: pgfId-2444319]You can configure the reporting system to place newly generated report files in your configured remote storage location. You can also move any locally stored report to your remote storage location. 
 
      
       
     
 
     
 
     [bookmark: pgfId-2383198]Note You cannot move reports in remote storage back to local storage.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2383191]To use remote storage, you must first configure a remote storage location. When configured, the remote storage location appears at the bottom of the report list. The location includes current disk usage for NFS and SMB mounted storage, but not for SSH. For configuration information, see Managing Remote Storage.
 
     [bookmark: pgfId-2340223]To store reports remotely as they are generated:
 
     [bookmark: pgfId-2340224]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2340225]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2340226]Step 2 Select the Reports tab.
 
     [bookmark: pgfId-2383171]The Reports page appears.
 
     [bookmark: pgfId-2383172]Step 3 Select the Enable Remote Storage of Reports check box at the bottom of the page.
 
     [bookmark: pgfId-2383167]The Defense Center stores newly generated reports in the remote location indicated at the bottom of the page. The Location column data for these reports is Remote.
 
     [bookmark: pgfId-2383168]You can move your reports in local storage to a remote storage location in batch mode or singly.
 
     [bookmark: pgfId-2383163]To move generated reports from local to remote storage:
 
     [bookmark: pgfId-2383164]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2340232]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2340233]Step 2 Select the Reports tab.
 
     [bookmark: pgfId-2340234]The Reports page appears.
 
     [bookmark: pgfId-2340235]Step 3 Select the check boxes next to the reports you want to move, then click Move.
 
      
       
     
 
     
 
     [bookmark: pgfId-2340236]Tip Select the check box at the top left of the page to move all reports on the page. If you have multiple pages of reports, a second check box appears that you can select to move all reports on all pages.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2340237]Step 4 Confirm that you want to move the reports. 
 
     [bookmark: pgfId-2387171]The reports are moved.
 
     [bookmark: pgfId-2512901]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2387174][bookmark: 31816]Managing Report Temp[bookmark: marker-2420440]lates and Report Files
 
    [bookmark: pgfId-2387175]License: Any
 
    [bookmark: pgfId-2181047]In addition to creating and editing templates, you can perform the following template management tasks:
 
     
     	 [bookmark: pgfId-2187483]Exporting and Importing Report Templates
 
     	 [bookmark: pgfId-2187618]Deleting Report Templates
 
    
 
    [bookmark: pgfId-2298387]You can also perform the following management tasks for your generated report files:
 
     
     	 [bookmark: pgfId-2298444]Downloading Reports
 
     	 [bookmark: pgfId-2339808]Deleting Reports
 
    
 
     
      [bookmark: pgfId-2337004][bookmark: 95225]Exporting and Importing Report Templates
 
     [bookmark: pgfId-2337005]License: Any
 
     [bookmark: pgfId-2380646]The file that you generate when you export a report template contains all necessary data to create the same report on another Defense Center. The export file, which is in a proprietary SFO format, includes:
 
      
      	 [bookmark: pgfId-2362796]the report template, with all section design elements and document attributes
 
      	 [bookmark: pgfId-2288842]all saved searches used in the report
 
      	 [bookmark: pgfId-2288843]all images used in the report
 
      	 [bookmark: pgfId-2288827]all custom tables used in the report
 
     
 
     [bookmark: pgfId-2532218]The only configuration that may be required after you import the template on another Defense Center is automatic report generation scheduling.
 
      
       
     
 
     
 
     [bookmark: pgfId-2532222]Note Importing and exporting report templates requires both Defense Centers to be at the same software version level.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2289469]To export a report template:
 
     [bookmark: pgfId-2289510]Access: Admin
 
     
 
     [bookmark: pgfId-2327942]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2327933]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2327934]The Report Templates page appears.
 ). 
     
 
     [bookmark: pgfId-2289754]The system produces a configuration package file with .sfo extension and opens an Opening Object pop-up window that displays the package’s file name.
 
     [bookmark: pgfId-2289840]Step 4 Select Save file and OK to save the file to your local computer.
 
     [bookmark: pgfId-2290161]Step 5 You can change the name of the .sfo package to a more descriptive one for your convenience. When you import the package, regardless of its name, the importing Defense Center will give the template the same name it had on the source Defense Center.
 
     [bookmark: pgfId-2512921]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2290749]The SFO files exported from a Defense Center contain all elements necessary to add the report template to another Defense Center. The import process therefore requires only uploading the package to the second Defense Center and running the import process.
 
     [bookmark: pgfId-2374442]To import a report template:
 
     [bookmark: pgfId-2328110]Access: Admin
 
     
 
     [bookmark: pgfId-2328111]Step 1 Select System > Tools > Import/Export.
 
     [bookmark: pgfId-2328112]The Import/Export page appears, including a list of the report templates on the Defense Center.
 
     [bookmark: pgfId-2290860]Step 2 Click Upload Package.
 
     [bookmark: pgfId-2290892]The Package Name page appears.
 
     [bookmark: pgfId-2328346]Step 3 You have two options:
 
      
       
       	 [bookmark: pgfId-2328351]Type the path to the package you want to upload.
 
       	 [bookmark: pgfId-2328352]Click  Browse to locate the package.
 
      
 
     
 
     [bookmark: pgfId-2477457]Step 4 Click Upload.
 
     [bookmark: pgfId-2477458]The Report Template section of the configuration list appears, showing the template to be imported.
 
     [bookmark: pgfId-2291399]Step 5 Select the check box next to the template and click Import.
 
     [bookmark: pgfId-2291638]The template appears in the list of configurations on the destination Defense Center.
 
     [bookmark: pgfId-2512937]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2337961][bookmark: 45009]Deleting Report Tem[bookmark: marker-2420450]plates
 
     [bookmark: pgfId-2338005]License: Any
 
     [bookmark: pgfId-2338013]Report templates remain listed on the Report Templates tab for reuse until you delete them. Note that you cannot delete Cisco-provided report templates.
 
      
       
     
 
     
 
     [bookmark: pgfId-2338427]Note Security Analysts can delete only report templates they created.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2338324]To delete a report template:
 
     [bookmark: pgfId-2338325]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2338326]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2338127]Step 2 Select the Report Templates tab.
 
     [bookmark: pgfId-2338128]The Report Templates page appears.
 ) and confirm. 
     
 
     [bookmark: pgfId-2338133]The template name disappears from the list.
 
     [bookmark: pgfId-2512960]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2339689][bookmark: 17636]Downloa[bookmark: marker-2420455]ding Reports
 
     [bookmark: pgfId-2339690]License: Any
 
     [bookmark: pgfId-2339691]You can download any report file to your local computer. From there, you can email it or distribute it electronically by other available means. For information on distributing reports automatically by email at generation time, see Distributing Reports by Email at Generation Time.
 
     [bookmark: pgfId-2339695]To download reports:
 
     [bookmark: pgfId-2339696]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2339697]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2339698]Step 2 Select the Reports tab.
 
     [bookmark: pgfId-2339699]The Reports page appears.
 
     [bookmark: pgfId-2339700]Step 3 Select the check boxes next to the reports you want to download, then click Download.
 
      
       
     
 
     
 
     [bookmark: pgfId-2339701]Tip Select the check box at the top left of the page to download all reports on the page. If you have multiple pages of reports, a second check box appears that you can select to download all reports on all pages.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2339702]Step 4 Follow your browser’s prompts to download the reports.
 
     [bookmark: pgfId-2339703]If you select multiple reports, they are downloaded in a single .zip file.
 
     [bookmark: pgfId-2512976]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2339109][bookmark: 52272]Deleting Re[bookmark: marker-2420460]ports
 
     [bookmark: pgfId-2362841]License: Any
 
     [bookmark: pgfId-2337362]You can delete your report files at any time. The procedure completely removes the files, and no recovery is possible. Although you still have the report template that generated the report, it may be difficult to regenerate a particular report file if the time window was expanding or sliding. For information on the time window, see Editing the Sections of a Report Template. Regeneration may also be difficult if your template uses input parameters. For information on using input parameters, see Using Input Parameters.
 
     [bookmark: pgfId-2337369]To delete reports:
 
     [bookmark: pgfId-2362852]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2337370]Step 1 Select Overview > Reporting.
 
     [bookmark: pgfId-2337371]Step 2 Select the Reports tab.
 
     [bookmark: pgfId-2337372]The Reports page appears.
 
     [bookmark: pgfId-2337373]Step 3 Select the check boxes next to the reports you want to delete, then click Delete.
 
      
       
     
 
     
 
     [bookmark: pgfId-2337374]Tip Select the check box at the top left of the page to delete all reports on the page. If you have multiple pages of reports, a second check box appears that you can select to delete all reports on all pages.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2337375]Step 4 Confirm the deletion.
 
     [bookmark: pgfId-2337376]The reports are deleted.
 
     [bookmark: pgfId-2512996]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1887838]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3085730][bookmark: 59184]Understanding and Us[bookmark: marker-3085729]ing Workflows 
      
      
 
     
 
 
    [bookmark: pgfId-3085734]A workflow is a tailored series of data pages on the Defense Center web interface that analysts can use to evaluate events generated by the system. The Defense Center provides three types of workflows: 
 
     
     	 [bookmark: pgfId-2339588] Predefined workflows [bookmark: marker-2763331], which are preset workflows installed on the system that you cannot modify or delete.
 
     	 [bookmark: pgfId-2489425] Saved custom workflows , which are predefined custom workflows that you can modify or delete.
 
     	 [bookmark: pgfId-2339691] Custom workflows [bookmark: marker-2763332], which are workflows that you create and customize for your specific needs.
 
    
 
    [bookmark: pgfId-3013326]For example, when you analyze intrusion events, you can choose from several predefined workflows specifically created for the task. 
 
    [bookmark: pgfId-3173540]Note that the data displayed in a workflow often depends on such factors as how you license and deploy your managed devices, whether you configure features that provide the data and, in the case of Series 2 appliances and Cisco NGIPS for Blue Coat X-Series, whether the appliance supports a feature that provides the data. For example, because neither the DC500 Defense Center nor Series 2 devices support URL filtering by category and reputation, the DC500 Defense Center does not display data for this feature and Series 2 devices do not detect this data.
 
    [bookmark: pgfId-3173528]See the following sections for more information about using predefined and custom workflows:
 
     
     	 [bookmark: pgfId-1677300]Components of a Workflow
 
     	 [bookmark: pgfId-1960052]Using Workflows
 
     	 [bookmark: pgfId-1960072]Using Custom Workflows
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2364926]Tip You can also use custom workflows as the basis for event reports. See Working with Reports for more information.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2364929][bookmark: 28260]Components of a[bookmark: marker-2400829] Workflow
 
    [bookmark: pgfId-3137342]License: Any
 
    [bookmark: pgfId-2364930]Workflows can include several types of pages, as described in the following sections.
 
    [bookmark: pgfId-2492796]Table Views
 
    [bookmark: pgfId-2644821]Table views include a[bookmark: marker-2400830] column for each of the fields in the database on which your workflow is based. 
 
    [bookmark: pgfId-2645120]For example, the table view of discovery events includes the Time, Event, IP Address, User, MAC Address, MAC Vendor, Port, Description, and Device columns.
 
    [bookmark: pgfId-3065793]By contrast, the table view of servers includes the Last Used, IP Address, Port, Protocol, Application Protocol, Vendor, Version, Web Application, Application Risk, Business Relevance, Hits, Source Type, Device, and Current User columns.
 
    [bookmark: pgfId-3065794]Drill-Down Pages
 
    [bookmark: pgfId-2644763]Drill-down pages[bookmark: marker-2400831] contain a subset of columns that are available in the database. 
 
    [bookmark: pgfId-2645145]For example, a drill-down page for discovery events might include only the IP Address, MAC Address, and Time columns. A drill-down page for intrusion events, on the other hand, might include the Priority, Impact Flag, Inline Result, and Message columns. 
 
    [bookmark: pgfId-2645146]Generally, drill-down pages are intermediate pages that you use to narrow your investigation to a few events before moving to a table view page.
 
    [bookmark: pgfId-2644773]Graphs
 
    [bookmark: pgfId-2644739]Workflows based on connection data can include graph pages, also called connection graphs. 
 
    [bookmark: pgfId-2645161]For example, a connection graph might display a line graph that shows the number of connections detected by the system over time. Generally, connection graphs are, like drill-down pages, intermediate pages that you use to narrow your investigation. For more information, see Working with Connection Graphs.
 
    [bookmark: pgfId-2644781]Final Pages
 
    [bookmark: pgfId-2364954]The final page of a workflow depends on the type of event on which the workflow is based:
 
    [bookmark: pgfId-2644911] – The host view is the final page for workflows based on applications, application details, discovery events, hosts, indications of compromise (IOC), servers, or any type of vulnerabilities. Viewing host profiles from this page allows you to easily view data on all IP addresses associated with hosts that have multiple addresses. For more information, see Using Host Profiles.
 
    [bookmark: pgfId-2720028] – The user detail view is the final page for workflows based on users and user activity. For more information, see Understanding User Details and Host History.
 
    [bookmark: pgfId-2644918] – The vulnerability detail view is the final page for workflows based on Cisco vulnerabilities. For more information, see Viewing Vulnerability Details.
 
    [bookmark: pgfId-2644931] – The packet view is the final page for workflows based on intrusion events. For more information, see Using the Packet View.
 
    [bookmark: pgfId-2644744]Workflows based on other kinds of events (for example, audit log events or malware events) do not have final pages.
 
    [bookmark: pgfId-2364961]See the following sections for more information on workflows:
 
     
     	 [bookmark: pgfId-2364965]Comparing Predefined and Custom Workflows
 
     	 [bookmark: pgfId-2489572]Comparing Workflows for Predefined and Custom Tables
 
     	 [bookmark: pgfId-2492822]Predefined Intrusion Event Workflows
 
     	 [bookmark: pgfId-3094844]Predefined Malware Workflows
 
     	 [bookmark: pgfId-3184245]Predefined File Workflows
 
     	 [bookmark: pgfId-3182548]Predefined Captured File Workflows
 
     	 [bookmark: pgfId-3184258]Predefined Connection Data Workflows
 
     	 [bookmark: pgfId-3184615]Predefined Security Intelligence Workflows
 
     	 [bookmark: pgfId-3069606]Predefined Host Workflows
 
     	 [bookmark: pgfId-3193593]Predefined Indications of Compromise Workflows
 
     	 [bookmark: pgfId-3069435]Predefined Applications Workflows
 
     	 [bookmark: pgfId-3069570]Predefined Application Details Workflows
 
     	 [bookmark: pgfId-3069585]Predefined Servers Workflows
 
     	 [bookmark: pgfId-3069620]Predefined Host Attributes Workflows
 
     	 [bookmark: pgfId-3069631]Predefined Discovery Events Workflows
 
     	 [bookmark: pgfId-3184283]Predefined User Workflows
 
     	 [bookmark: pgfId-3014858]Predefined Vulnerabilities Workflows
 
     	 [bookmark: pgfId-3067430]Predefined Third-Party Vulnerabilities Workflows
 
     	 [bookmark: pgfId-3014801]Predefined Correlation and White List Workflows
 
     	 [bookmark: pgfId-2364985]Predefined System Workflows
 
     	 [bookmark: pgfId-2489608]Saved Custom Workflows
 
    
 
     
      [bookmark: pgfId-2365003][bookmark: 48549]Comparing Predefined and[bookmark: marker-2400832] Custom Workflows
 
     [bookmark: pgfId-2995261]License: Any
 
     [bookmark: pgfId-2492827]The FireSIGHT System is delivered with a set of predefined workflows (described in the sections that follow) that you can use to analyze the events and other data it collects.
 
     [bookmark: pgfId-2646933]Custom workflows are workflows that you create to meet the unique needs of your organization. When you create a custom workflow, you choose the kind of event (or database table) on which the workflow is based. On the Defense Center, you can base a custom workflow on a custom table. You can also choose the pages a custom workflow contains; custom workflows can contain drill-down, table view, and host or packet view pages. 
 
     [bookmark: pgfId-2646909]The Defense Center is delivered with several saved custom workflows, which are based on the saved custom tables that are also delivered with the Defense Center. The differences between workflows based on predefined and custom tables is described in the next section, Comparing Workflows for Predefined and Custom Tables.
 
    
 
     
      [bookmark: pgfId-2489762][bookmark: 33369]Comparing Workflows for Predefine[bookmark: marker-2763333]d and Custo[bookmark: marker-3065038]m Tables
 
     [bookmark: pgfId-2995312]License: FireSIGHT
 
     [bookmark: pgfId-2507594]You can use the custom tables feature to create tables that use the data from two or more types of events. This is useful because you can, for example, create tables and workflows that correlate intrusion event data with discovery data to allow simple searches for events that affect critical systems. See Using Custom Tables for information about creating custom tables.
 
     [bookmark: pgfId-2315534]Each custom table has, by default, a workflow that you can use to view the events associated with the table. The features in the workflow differ depending on which type of table you use. For example, custom table workflows based on the intrusion event table always end with the packet view. However, custom table workflows based on discovery events end with the host view.
 
     [bookmark: pgfId-3134929]Unlike workflows based on the predefined event tables, workflows based on custom tables do not have links to other types of workflows.
 
    
 
     
      [bookmark: pgfId-3134932][bookmark: 69423]Predefined Intrusi  [bookmark: marker-3134931]on Event Workflows
 
     [bookmark: pgfId-3134936]License: Protection
 
     [bookmark: pgfId-3122351]The following table describes the predefined intrusion event workflows included with the FireSIGHT System. For information on accessing these workflows, see Viewing Intrusion Events and Reviewing Intrusion Events.
 
     [bookmark: pgfId-3122428]:
 
      
       
        
        [bookmark: pgfId-3122367]Table 58-1 [bookmark: 11925]Predefined Intrusion Event Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3122371]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3122373]Description 
          
  
        
 
         
         	[bookmark: pgfId-3122375]Destination Port
  
         	[bookmark: pgfId-3122377]Because destination ports are usually tied to an application, this workflow can help you detect applications that are experiencing an uncommonly high volume of alerts. The Destination Port column can also help you identify applications that should not be present on your network. 
 [bookmark: pgfId-3122378]This workflow begins with a page showing the destination ports associated with the intrusion events, followed by a page showing the event types that were generated. You can then see a tabular view of event information, called the table view of events, followed by a packet view that shows the decoded contents of the packets associated with each event.
  
        
 
         
         	[bookmark: pgfId-3122380]Event-Specific
  
         	[bookmark: pgfId-3122382]This workflow provides two useful features. Events that occur frequently may indicate:
 
           
           	 [bookmark: pgfId-3122383]false positives
 
           	 [bookmark: pgfId-3122384]a worm
 
           	 [bookmark: pgfId-3122385]a badly misconfigured network
 
          
 [bookmark: pgfId-3122386]Events that occur infrequently are most likely evidence of a targeted attack and warrant special attention. 
 [bookmark: pgfId-3122387]This workflow begins with a page showing the event types that were generated. You can then view a page with two tables, one listing the source IP addresses associated with the events, the other showing the destination IP addresses associated with the events. The last pages in the workflow are the table view of events and the packet view.
  
        
 
         
         	[bookmark: pgfId-3122389]Events by Priority and Classification
  
         	[bookmark: pgfId-3122391]This workflow lists events and their type in order of event priority, along with a count showing how many times each event has occurred.
 [bookmark: pgfId-3122392]This workflow begins with a drill-down page that contains the priority level, classification and count of each listed event. The last pages in the workflow are the table view of events and the packet view.
  
        
 
         
         	[bookmark: pgfId-3122394]Events to Destinations
  
         	[bookmark: pgfId-3122396]This workflow provides a high-level view of which host IP addresses are being attacked and the nature of the attack; where available, you can also see information about the countries involved in attacks.
 [bookmark: pgfId-3122397]This workflow begins with a page of paired event types and destination IP addresses that you can use to investigate what types of events are directed towards specific IP addresses. The last pages in the workflow are the table view of events and the packet view.
  
        
 
         
         	[bookmark: pgfId-3122399]IP-Specific
  
         	[bookmark: pgfId-3122401]This workflow shows which host IP addresses are generating the most alerts. Hosts with the greatest number of events are either public-facing and receiving worm-type traffic (indicating a good place to look for tuning) or require further investigation to determine the cause of the alerts. Hosts with the lowest counts also warrant investigation as they could be the subject of a targeted attack. Low counts may also indicate that a host may not belong on the network.
 [bookmark: pgfId-3122402]This workflow begins with a page showing two tables, one each for the source and destination IP addresses that are associated with the events. The next page shows the event types that were generated. The last pages in the workflow are the table view of events and the packet view.
  
        
 
         
         	[bookmark: pgfId-3122404]Impact and Priority
  
         	[bookmark: pgfId-3122406]This workflow lets you find high-impact recurring events quickly. The reported impact level is shown with the number of times the event has occurred. Using this information, you can identify the high-impact events that recur most often, which might be an indicator of a widespread attack on your network. 
 [bookmark: pgfId-3122407]This workflow begins with a page showing the impact level, priority, and count associated with each event. Next, a drill-down page appears with the source and destination IP addresses for each event. Events on the second page are sorted by count. The last pages in the workflow are the table view of events and the packet view.
  
        
 
         
         	[bookmark: pgfId-3122409]Impact and Source
  
         	[bookmark: pgfId-3122411]This workflow can help you identify the source of an attack in progress. The reported impact level is shown with the associated source IP address for the event. If, for example, events with a level 1 impact are coming from the same source IP address repeatedly, they may indicate an attacker who has identified vulnerable systems and is targeting them. 
 [bookmark: pgfId-3122412]This workflow begins with a page showing the impact level, source IP address, priority, and count associated with each event. Within each event level, events are sorted by count, then priority. Next, a drill-down page appears with the source and destination IP addresses for each event. Events on the second page are sorted by count. The last pages in the workflow are the table view of events and the packet view.
  
        
 
         
         	[bookmark: pgfId-3122414]Impact to Destination
  
         	[bookmark: pgfId-3122416]You can use this workflow to identify events repeatedly occurring on vulnerable computers, so you can address the vulnerabilities on those systems and stop any attacks in progress. 
 [bookmark: pgfId-3122417]This workflow begins with a page showing the impact level, inline result (whether the packet was or would have been dropped), destination IP address, priority, and count associated with each event. Within each event level, events are sorted by count, then priority. Next, a drill-down page appears with the source and destination IP addresses for each event. Events on the second page are sorted by count. The last pages in the workflow are the table view of events and the packet view.
  
        
 
         
         	[bookmark: pgfId-3122419]Source Port
  
         	[bookmark: pgfId-3122421]This workflow indicates which servers are generating the most alerts. You can use this information to identify areas that require tuning, and to decide which servers require attention. 
 [bookmark: pgfId-3122422]This workflow begins with a page showing the source ports associated with the intrusion events, followed by a page showing the types of events that were generated. The last pages in the workflow are the table view of events and the packet view.
  
        
 
         
         	[bookmark: pgfId-3122424]Source and Destination
  
         	[bookmark: pgfId-3122426]This workflow identifies host IP addresses sharing high levels of alerts. Pairs at the top of the list could be false positives, and may identify areas that require tuning. You can check pairs at the bottom of the list for targeted attacks, for users accessing resources they should not be accessing, or for hosts that do not belong on the network.
 [bookmark: pgfId-3122427]This workflow begins with a page showing the source and destination IP addresses for each event, followed by a page showing the types of events that were generated. The last pages in the workflow are the table view of events and the packet view.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3173641][bookmark: 46607]Predefined Malware Workflows
 
     [bookmark: pgfId-3173642]License: Any
 
     [bookmark: pgfId-3173700]Supported Devices: feature dependent
 
     [bookmark: pgfId-3173720]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-3173646]The following table describes the predefined malware workflows included on the Defense Center. All predefined malware workflows use the table view of malware events. 
 
     [bookmark: pgfId-3173743]Note that because the DC500 Series 2 Defense Center, Series 2 devices, and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, the DC500 Defense Center does not display data for this feature and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect this data.
 
     [bookmark: pgfId-3173735]For information on accessing malware events, see Working with Malware Events.
 
     [bookmark: pgfId-3116875]
 
      
       
        
        [bookmark: pgfId-3116860]Table 58-2 [bookmark: 92641]Predefined Malware Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3116864]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3116866]Description 
          
  
        
 
         
         	[bookmark: pgfId-3116868]Malware Summary
  
         	[bookmark: pgfId-3116870]This workflow provides a list of the malware detected in network traffic or by endpoint-based FireAMP Connectors, grouped by individual threat.
  
        
 
         
         	[bookmark: pgfId-3122202]Malware Event Summary
  
         	[bookmark: pgfId-3122204]This workflow provides a quick breakdown of the different malware event types and subtypes.
  
        
 
         
         	[bookmark: pgfId-3122178]Hosts Receiving Malware
  
         	[bookmark: pgfId-3126087]This workflow provides a list of host IP addresses that have received malware, grouped by the malware files’ associated dispositions.
  
        
 
         
         	[bookmark: pgfId-3122190]Hosts Sending Malware
  
         	[bookmark: pgfId-3126140]This workflow provides a list of host IP addresses that have sent malware, grouped by the malware files’ associated dispositions.
  
        
 
         
         	[bookmark: pgfId-3116872]Applications Introducing Malware
  
         	[bookmark: pgfId-3126091]This workflow provides a list of host IP addresses that have received files, grouped by the associated malware dispositions for those files.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3116878][bookmark: 29053]Predefined File Workflows
 
     [bookmark: pgfId-3116882]License: Protection
 
      
       
        
        [bookmark: pgfId-3117955]Table 58-3 [bookmark: 18460]Predefined File Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3117959]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3117961]Description 
          
  
        
 
         
         	[bookmark: pgfId-3117963]File Summary
  
         	[bookmark: pgfId-3117965]This workflow provides a quick breakdown of the different file event categories and types, along with any associated malware dispositions.
  
        
 
         
         	[bookmark: pgfId-3117967]Hosts Receiving Files
  
         	[bookmark: pgfId-3125952]This workflow provides a list of host IP addresses that have received files, grouped by the associated malware dispositions for those files.
  
        
 
         
         	[bookmark: pgfId-3117971]Hosts Sending Files
  
         	[bookmark: pgfId-3126061]This workflow provides a list of host IP addresses that have sent files, grouped by the associated malware dispositions for those files.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3117476][bookmark: 95252]Predefined Captured File Workflows
 
     [bookmark: pgfId-3181068]License: Malware
 
     [bookmark: pgfId-3181069]Supported Devices: feature dependent
 
     [bookmark: pgfId-3181070]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-3181074]The following table describes the predefined captured file workflows included on the Defense Center. All predefined captured file workflows use the table view of captured files. 
 
     [bookmark: pgfId-3181087]Note that because the DC500 Series 2 Defense Center, Series 2 devices, and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, the DC500 Defense Center does not display data for this feature and Series 2 devices and Cisco NGIPS for Blue Coat X-Series do not detect this data.
 
      
       
        
        [bookmark: pgfId-3181357]Table 58-4 [bookmark: 26961]Predefined Captured File Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3181361]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3181363]Description 
          
  
        
 
         
         	[bookmark: pgfId-3181365]Captured File Summary
  
         	[bookmark: pgfId-3181550]This workflow provides a breakdown of captured files based on type, category, and threat score.
  
        
 
         
         	[bookmark: pgfId-3181369]Dynamic Analysis Status
  
         	[bookmark: pgfId-3181619]This workflow provides a count of captured files based on whether they have been submitted for dynamic analysis.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3180955][bookmark: 41624]Predefined Connection Data Workflows
 
     [bookmark: pgfId-3116899]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3117996]Table 58-5 [bookmark: 76009]Predefined Connection Data Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3118000]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3118002]Description 
          
  
        
 
         
         	[bookmark: pgfId-3118004]Connection Events
  
         	[bookmark: pgfId-3118006]This workflow provides a summary view of basic connection and detected application information, which you can then use to drill down to the table view of events.
  
        
 
         
         	[bookmark: pgfId-3118008]Connections by Application
  
         	[bookmark: pgfId-3118010]This workflow contains a graph of the 10 most active applications on the monitored network segment, based on the number of detected connections.
  
        
 
         
         	[bookmark: pgfId-3118012]Connections by Initiator
  
         	[bookmark: pgfId-3118014]This workflow contains a graph of the 10 most active host IP addresses on the monitored network segment, based on the number of connections where the host initiated the connection transaction.
  
        
 
         
         	[bookmark: pgfId-3118016]Connections by Port
  
         	[bookmark: pgfId-3118018]This workflow contains a graph of the 10 most active ports on the monitored network segment, based on the number of detected connections.
  
        
 
         
         	[bookmark: pgfId-3118020]Connections by Responder
  
         	[bookmark: pgfId-3118022]This workflow contains a graph of the 10 most active host IP addresses on the monitored network segment, based on the number of connections where the host IP was the responder in the connection transaction.
  
        
 
         
         	[bookmark: pgfId-3118024]Connections over Time
  
         	[bookmark: pgfId-3118026]This workflow contains a graph of the total number of connections on the monitored network segment over time.
  
        
 
         
         	[bookmark: pgfId-3118028]Traffic by Application
  
         	[bookmark: pgfId-3118030]This workflow contains a graph of the 10 most active applications on the monitored network segment, based on the number of kilobytes transmitted.
  
        
 
         
         	[bookmark: pgfId-3118032]Traffic by Initiator
  
         	[bookmark: pgfId-3118034]This workflow contains a graph of the 10 most active host IP addresses on the monitored network segment, based on the total number of kilobytes transmitted from each address.
  
        
 
         
         	[bookmark: pgfId-3118036]Traffic by Port
  
         	[bookmark: pgfId-3118038]This workflow contains a graph of the 10 most active ports on the monitored network segment, based on the number of kilobytes transmitted.
  
        
 
         
         	[bookmark: pgfId-3118040]Traffic by Responder
  
         	[bookmark: pgfId-3118042]This workflow contains a graph of the 10 most active host IP addresses on the monitored network segment, based on the total number of kilobytes received by each address.
  
        
 
         
         	[bookmark: pgfId-3118044]Traffic over Time
  
         	[bookmark: pgfId-3118046]This workflow contains a graph of the total kilobytes transmitted on the monitored network segment over time.
  
        
 
         
         	[bookmark: pgfId-3118048]Unique Initiators by Responder
  
         	[bookmark: pgfId-3118050]This workflow contains a graph of the 10 most active responding host IP addresses on the monitored network segment, based on the number of unique initiators that contacted each address.
  
        
 
         
         	[bookmark: pgfId-3118052]Unique Responders by Initiator
  
         	[bookmark: pgfId-3118054]This workflow contains a graph of the 10 most active initiating host IP addresses on the monitored network segment, based on the number of unique responders that the addresses contacted.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2637707][bookmark: 93524]Predefined Security [bookmark: marker-3200727]Intelligence Workflows
 
     [bookmark: pgfId-3184376]License: Protection
 
     [bookmark: pgfId-3184608]Supported Devices: Any except Series 2
 
     [bookmark: pgfId-3185435]Supported Defense Centers: Any except DC500
 
      
       
        
        [bookmark: pgfId-3186465]Table 58-6 [bookmark: 70442]Predefined Security Intelligence Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3186469]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3186471]Description 
          
  
        
 
         
         	[bookmark: pgfId-3186473]Security Intelligence Events
  
         	[bookmark: pgfId-3186475]This workflow provides a summary view of basic Security Intelligence and detected application information, which you can then use to drill down to the table view of events.
  
        
 
         
         	[bookmark: pgfId-3186477]Security Intelligence Summary
  
         	[bookmark: pgfId-3186479]This workflow is identical to the Security Intelligence Events workflow, but begins with the Security Intelligence Summary page, which lists security intelligence events by category and count only.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3184300][bookmark: 34475]Predefined Host Workflows
 
     [bookmark: pgfId-3045901]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3045918]Table 58-7 [bookmark: 16365]Predefined Host Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3045922]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3045924]Description 
          
  
        
 
         
         	[bookmark: pgfId-3045964]Hosts
  
         	[bookmark: pgfId-3045966]This workflow contains a table view of hosts followed by the host view. Workflow views based on the Hosts table allow you to easily view data on all IP addresses associated with a host. See Viewing Hosts for more information.
  
        
 
         
         	[bookmark: pgfId-3045985]Operating System Summary
  
         	[bookmark: pgfId-3045987]You can use this workflow to analyze the operating systems in use on your network. This workflow provides a series of pages that start with a list of the operating systems and operating system vendors on your network, continuing with the number of hosts running each version of that operating system. The next page lists hosts by criticality, IP address, and NetBIOS name, with their associated operating systems and operating system vendors. The workflow finishes with a table view of hosts, followed by the host view. See Viewing Hosts for more information.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3060961][bookmark: 35294]Predefined Indications of Com[bookmark: marker-3200732]promise Workflows
 
     [bookmark: pgfId-3192580]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3193072]Table 58-8 [bookmark: 56594]Predefined Indications of Compromise Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3193076]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3193078]Description 
          
  
        
 
         
         	[bookmark: pgfId-3193080]Indications of Compromise
  
         	[bookmark: pgfId-3193082]This workflow begins with a summary view of IOC data grouped by count and category, followed by a detail view that further subdivides the summary data by event type. Next is a full table view of IOC data. The workflow concludes with the host view. For more information on viewing and interpreting IOC data, see Working with Indications of Compromise.
  
        
 
         
         	[bookmark: pgfId-3193084]Indications of Compromise by Host
  
         	[bookmark: pgfId-3193086]You can use this workflow to gauge which hosts on your network are most likely to be compromised (based on IOC data). This workflow contains a view of host IP addresses by IOC data count, followed by a table view of IOC data and concluding with the host view. For more information on viewing and interpreting IOC data, see Working with Indications of Compromise.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3192501][bookmark: 65251]Predefined Applications Workflows
 
     [bookmark: pgfId-3061115]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3061617]Table 58-9 [bookmark: 50665]Predefined Applications Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3061621]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3061623]Description 
          
  
        
 
         
         	[bookmark: pgfId-3061625]Application Business Relevance
  
         	[bookmark: pgfId-3061627]You can use this workflow to analyze running applications of each estimated business relevance level on your network, so you can monitor appropriate use of your network resources. This workflow begins with a count of hosts running applications of each relevance level, followed by a table of individual applications with their business relevance levels and host counts, a table view of applications, and the host view. See Viewing Applications for more information.
  
        
 
         
         	[bookmark: pgfId-3061632]Application Category
  
         	[bookmark: pgfId-3061634]You can use this workflow to analyze running applications of each category (such as email, search engine, or social networking) on your network, so you can monitor appropriate use of your network resources. This workflow begins with a count of hosts running applications of each category, followed by a count of hosts running individual applications, a table view of applications, and the host view. See Viewing Applications for more information.
  
        
 
         
         	[bookmark: pgfId-3061702]Application Risk
  
         	[bookmark: pgfId-3061704]You can use this workflow to analyze running applications of each estimated security risk level on your network, so you can estimate the potential risk of users’ activity and take appropriate action. This workflow begins with a count of hosts running applications of each risk level, followed by a table of individual applications with their business relevance levels and host counts, a table view of applications, and the host view. See Viewing Applications for more information.
  
        
 
         
         	[bookmark: pgfId-3079703]Application Summary
  
         	[bookmark: pgfId-3079705]You can use this workflow to obtain detailed information about the applications and associated hosts on your network, so you can closely examine host application activity. This workflow begins with a list of individual host IP addresses running applications, followed by a table view of applications and the host view.
  
        
 
         
         	[bookmark: pgfId-3066009]Applications
  
         	[bookmark: pgfId-3066011]You can use this workflow to analyze running applications on your network, so you can gain an overview of how the network is being used. This workflow begins with a count of hosts running individual applications, followed by a table view of applications and the host view. See Viewing Applications for more information.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3060921][bookmark: 87279]Predefined Application Details Workflows
 
     [bookmark: pgfId-3046769]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3046780]Table 58-10 [bookmark: 78128]Predefined Application Details Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3046784]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3046786]Description 
          
  
        
 
         
         	[bookmark: pgfId-3054740]Application Details
  
         	[bookmark: pgfId-3055340]You can use this workflow to analyze the client applications on your network in more detail. This workflow contains a series of pages that begin with a list of the client applications and application products on your network and a count of the number of hosts running each application. You can then view the number of hosts running each version of that application. The next page lets you identify which applications have been accessed most frequently on specific hosts. The workflow then provides a table view of client applications, followed by the host view. See Viewing Application Details for more information.
  
        
 
         
         	[bookmark: pgfId-3046889]Clients
  
         	[bookmark: pgfId-3046891]This workflow contains a table view of client applications, followed by the host view. See Viewing Application Details for more information.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3047497][bookmark: 52575]Predefined Servers Workflows
 
     [bookmark: pgfId-3047501]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3067746]Table 58-11 [bookmark: 33780]Predefined Servers Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3067750]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3067752]Description 
          
  
        
 
         
         	[bookmark: pgfId-3067754]Network Applications by Count
  
         	[bookmark: pgfId-3067756]You can use this workflow to analyze the most frequently used applications on your network. This workflow contains a series of pages that show applications with a count of hosts where each application occurs, then add the vendor and version of each application. The workflow then concludes with a table view listing the applications per host, followed by the host view. See Viewing Servers for more information.
  
        
 
         
         	[bookmark: pgfId-3067761]Network Applications by Hit
  
         	[bookmark: pgfId-3067763]You can use this workflow to analyze the most active applications on your network. This workflow contains a series of pages that show applications with a count of how often each application is accessed, then add the vendor and version information for each application. The workflow finishes with a page containing a table view listing the applications per host, followed by the host view. See Viewing Servers for more information.
  
        
 
         
         	[bookmark: pgfId-3067768]Server Details
  
         	[bookmark: pgfId-3067770]You can use this workflow to analyze the vendors and versions of detected server application protocols in detail. The workflow contains a list of servers associated with their vendors, then a list of servers correlated with both vendor and version, finishing with a table view of servers and the host view.
  
        
 
         
         	[bookmark: pgfId-3067772]Servers
  
         	[bookmark: pgfId-3067774]This workflow contains a table view of applications followed by the host view. See Viewing Servers for more information.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3068067][bookmark: 88840]Predefined Host Attributes Workflows
 
     [bookmark: pgfId-3068071]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3068082]Table 58-12 [bookmark: 94552]Predefined Host Attributes Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3068086]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3068088]Description 
          
  
        
 
         
         	[bookmark: pgfId-3068090]Attributes
  
         	[bookmark: pgfId-3068092]You can use this workflow to monitor IP addresses of hosts on your network and the hosts’ status. This workflow begins with a table view of host attributes that lists individual IP addresses with current user, host criticality, notes, and white list compliance. It finishes with the host view. For more information, see Viewing Host Attributes.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3068801][bookmark: 33437]Predefined Discovery Events Workflows
 
     [bookmark: pgfId-3068805]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3068816]Table 58-13 [bookmark: 59092]Predefined Discovery Event Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3068820]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3068822]Description 
          
  
        
 
         
         	[bookmark: pgfId-3068824]Discovery Events
  
         	[bookmark: pgfId-3068826]This workflow provides a detailed list, in table view form, of discovery events, followed by the host view. For more information, see Understanding the Discovery Events Table.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3068785][bookmark: 45269]Predefined User Workflows
 
     [bookmark: pgfId-3067785]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3048582]Table 58-14 [bookmark: 91542]Predefined User Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3048586]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3048588]Description 
          
  
        
 
         
         	[bookmark: pgfId-3048649]Users
  
         	[bookmark: pgfId-3048690]This workflow provides a list of user information collected from user events or from the LDAP server connection. For details about the user identity workflow, see Viewing Users.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3048536][bookmark: 42678]Predefined Vulnerabilities Workflows
 
     [bookmark: pgfId-3048540]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3015777]Table 58-15 [bookmark: 23283]Predefined Vulnerabilities Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3015781]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3015783]Description 
          
  
        
 
         
         	[bookmark: pgfId-3015785]Vulnerabilities
  
         	[bookmark: pgfId-3049061]You can use this workflow to review s a table view of vulnerabilities showing all the vulnerabilities in the database, followed by a table view of only those active vulnerabilities that apply to the detected hosts on your network.The workflow ends in a vulnerability detail view, which contains a detailed description for every vulnerability that meets your constraints. For more information, see Viewing Vulnerabilities.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2490097][bookmark: 27990]Predefined Third-Party Vulnerabilities Workflows
 
     [bookmark: pgfId-3066601]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3066618]Table 58-16 [bookmark: 13823]Predefined Third-Party Vulnerabilities Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3066622]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3066624]Description 
          
  
        
 
         
         	[bookmark: pgfId-3066630]Vulnerabilities by IP Address
  
         	[bookmark: pgfId-3066632]You can use this workflow to see quickly how many third-party vulnerabilities you have detected per host IP address on your monitored network. The workflow concludes with a table view of third-party vulnerabilities, followed by the host view. For more information, see Viewing Third-Party Vulnerabilities.
  
        
 
         
         	[bookmark: pgfId-3066634]Vulnerabilities by Source
  
         	[bookmark: pgfId-3066636]You can use this workflow to see quickly how many third-party vulnerabilities you have detected per third-party vulnerability source, such as the QualysGuard Scanner. This workflow provides some details about those vulnerabilities on an intermediate drill-down page, then concludes with a table view of third-party vulnerabilities and the host view. For more information, see Viewing Third-Party Vulnerabilities.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3066482][bookmark: 49209]Predefined Correlation and White List Workflows
 
     [bookmark: pgfId-2995432]License: FireSIGHT
 
      
       
        
        [bookmark: pgfId-3067968]Table 58-17 Predefined Correlation Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3067972]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3067974]Description 
          
  
        
 
         
         	[bookmark: pgfId-3067976]Correlation Events
  
         	[bookmark: pgfId-3067980]This workflow contains a table view of correlation events. See Working with Correlation Events for more information.
  
        
 
         
         	[bookmark: pgfId-3067983]White List Events
  
         	[bookmark: pgfId-3067987]This workflow contains a table view of white list events. See Working with White List Events for more information.
  
        
 
         
         	[bookmark: pgfId-3067990]Host Violation Count
  
         	[bookmark: pgfId-3067992]This workflow provides a series of pages that list all the host IP addresses that violate at least one white list. The first page sorts the addresses based on the number of violations per address, with the IP addresses with the most number of violations at the top of the list. If a host IP address violates more than one white list, there is a separate row for each violated white list. The workflow also contains a table view of white list violations that lists all violations, with the most recently detected violation at the top of the list. Each row in the table contains a single detected violation. See Working with White List Violations for more information.
  
        
 
         
         	[bookmark: pgfId-3067997]White List Violations
  
         	[bookmark: pgfId-3067999]This workflow includes a table view of white list violations that lists all violations with the most recently detected violation at the top of the list. Each row in the table contains a single detected violation. See Working with White List Violations for more information.
  
        
 
         
         	[bookmark: pgfId-3068004]Status
  
         	[bookmark: pgfId-3068006]This workflow contains a table view of remediation status, which includes the name of the policy that was violated and the name and status of the remediation that was applied. See Working with Remediation Status Events for more information.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3068013][bookmark: 43118]Predefined System Workflows
 
     [bookmark: pgfId-3068014]License: Any
 
      
       
        
        [bookmark: pgfId-3049198]Table 58-18 Additional Predefined Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3049202]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-3049204]Description 
          
  
        
 
         
         	[bookmark: pgfId-3049206]Audit Log
  
         	[bookmark: pgfId-3049209]This workflow contains a table view of the audit log that lists audit events. See Viewing Audit Records for more information.
  
        
 
         
         	[bookmark: pgfId-3049214]Health Events
  
         	[bookmark: pgfId-3049217]This workflow displays events triggered by the health monitoring policy. See Working with the Health Events Table View for more information.
  
        
 
         
         	[bookmark: pgfId-3049225]Rule Update Import Log
  
         	[bookmark: pgfId-3049227]This workflow contains a table view listing information about both successful and failed rule update imports. For more information, see Importing Rule Updates and Local Rule Files. 
  
        
 
         
         	[bookmark: pgfId-3049235]Scan Results
  
         	[bookmark: pgfId-3049237]This workflow contains a table view listing each completed scan. For more information, see Working with Active Scan Results.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2995734][bookmark: 31299]Saved Custom[bookmark: marker-2995733] Workflows
 
     [bookmark: pgfId-2996113]License: Protection + FireSIGHT
 
      
       
        
        [bookmark: pgfId-2995975]Table 58-19 Saved Custom Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-2995979]Workflow Name 
          
  
         	 
           
           [bookmark: pgfId-2995981]Description 
          
  
        
 
         
         	[bookmark: pgfId-2995983]Events by Impact, Priority, and Host Criticality
  
         	[bookmark: pgfId-2995995]You can use this workflow to quickly pick out and focus in on hosts that are important to your network, currently vulnerable, and possibly currently under attack.
 [bookmark: pgfId-2995996]By default, this workflow starts with a summary of events sorted by impact level, then by host criticality, and then by the number of occurrences of the event. You can use the second page of the workflow to drill down and view the source and destination addresses where specific events occur. The workflow concludes with a table view of Intrusion Events with Destination Criticality, then the packet view. This workflow is based on the Intrusion Events with Destination Criticality custom table. For more information, see Understanding Custom Tables.
  
        
 
         
         	[bookmark: pgfId-3055933]Events by Priority and Classification
  
         	[bookmark: pgfId-3069667]This workflow lists events and their type in order of event priority, along with a count showing how many times each event has occurred.
 [bookmark: pgfId-3055935]This workflow begins with a drill-down page that contains the priority level, classification and count of each listed event. The last pages in the workflow are the table view of events and the packet view. This workflow is based on the Intrusion Events custom table. For more information, see Understanding Custom Tables.
  
        
 
         
         	[bookmark: pgfId-2996001]Events with Destination, Impact, and Host Criticality
  
         	[bookmark: pgfId-2996013]You can use this workflow to find the most recent attacks on hosts that are important to your network and currently vulnerable.
 [bookmark: pgfId-2996014]By default, this workflow starts with a list of the most recent events, sorted by impact level. The next page of the workflow provides a table view of Intrusion Events with Destination Criticality, followed by the packet view. This workflow is based on the Intrusion Events with Destination Criticality custom table. For more information, see Understanding Custom Tables.
  
        
 
         
         	[bookmark: pgfId-2996019]Hosts with Servers Default Workflow
  
         	[bookmark: pgfId-2996028]You can use this workflow to quickly view the basic information in the Hosts with Servers custom table. 
 [bookmark: pgfId-2996029]By default, this workflow begins with a table view of hosts with servers, followed by the host view. This workflow is based on the Hosts with Servers custom table. For more information, see Understanding Custom Tables.
  
        
 
         
         	[bookmark: pgfId-2996034]Intrusion Events with Destination Criticality Default Workflow
  
         	[bookmark: pgfId-2996046]You can use this workflow to quickly view the basic information in the Intrusion Events with Destination Criticality custom table. 
 [bookmark: pgfId-2996047]By default, this workflow starts with a table view of Intrusion Events with Destination Criticality, followed by the packet view. This workflow is based on the Intrusion Events with Destination Criticality custom table. For more information, see Understanding Custom Tables.
  
        
 
         
         	[bookmark: pgfId-2996052]Intrusion Events with Source Criticality Default Workflow
  
         	[bookmark: pgfId-2996064]You can use this workflow to quickly view the basic information in the Intrusion Events with Source Criticality custom table. 
 [bookmark: pgfId-2996065]By default, this workflow starts with a table view of Intrusion Events with Source Criticality, followed by the packet view. This workflow is based on the Intrusion Events with Source Criticality custom table. For more information, see Understanding Custom Tables.
  
        
 
         
         	[bookmark: pgfId-2996070]Server and Host Details
  
         	[bookmark: pgfId-2996079]You can use this workflow to determine what servers are most frequently used on your network and which hosts are running those servers. 
 [bookmark: pgfId-2996080]By default, this workflow begins with a summary of servers with the frequency of access for each service. The next page lists servers by operating system vendor and version. The workflow concludes with a table view of hosts with servers, followed by the host view. This workflow is based on the Hosts with Servers custom table. For more information, see Understanding Custom Tables.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2349287][bookmark: 57314]Using[bookmark: marker-2400840] Workflows
 
    [bookmark: pgfId-2996169]License: Any
 
    [bookmark: pgfId-2349272]The drill-down and table view pages in workflows allow you to quickly narrow your view of the data so you can zero in on events that are significant to your analysis. Although the data in each type of workflow is different, all workflows share a common set of features. The following sections describe these features and explain how to use them:
 
     
     	 [bookmark: pgfId-2282646]Selecting Workflows describes the workflow selection page and how to select a workflow to use.
 
     	 [bookmark: pgfId-2282650]Understanding the Workflow Toolbar describes the toolbar options available in workflows.
 
     	 [bookmark: pgfId-1826503]Using Workflow Pages describes the features that appear on all workflow pages and explains how to use them.
 
     	 [bookmark: pgfId-1843583]Setting Event Time Constraints describes how to set the time range for event-based workflows. The workflow includes events generated in the specified time range.
 
     	 [bookmark: pgfId-1841548]Constraining Events describes features that are used in workflows to constrain, or narrow, the view of data in workflows and to advance through workflow pages.
 
     	 [bookmark: pgfId-2368989]Using Compound Constraints explains how compound constraints can be used and provides examples.
 
     	 [bookmark: pgfId-1818005]Sorting Drill-Down Workflow Pages describes features for sorting the data displayed in workflows, and for removing and restoring table columns to view.
 
     	 [bookmark: pgfId-1818006]Selecting Rows on a Workflow Page describes how to select data rows in the displayed table that you want to analyze or on which you want to perform some other action.
 
     	 [bookmark: pgfId-1974750]Navigating to Other Pages in the Workflow describes how to open other workflows using the constraints, including any selected events, from the current workflow.
 
     	 [bookmark: pgfId-2490749]Navigating Between Workflows describes the  Jump to drop-down list and explains how you can use it to apply the current constraints to a different workflow.
 
     	 [bookmark: pgfId-1843605]Searching for Events provides information about the feature used to search event data.
 
     	 [bookmark: pgfId-1843592]Using Bookmarks describes how to create, manage, and use bookmarks.
 
    
 
     
      [bookmark: pgfId-1840401][bookmark: 96420]Sele[bookmark: SelectWorkflow]cting[bookmark: marker-2400841] Workflows
 
     [bookmark: pgfId-3182364]License: Any
 
     [bookmark: pgfId-1840403]The FireSIGHT System provides predefined workflows for the types of data listed in the following table.
 
     [bookmark: pgfId-1962432]
 
      
       
        
        [bookmark: pgfId-3049270]Table 58-20 [bookmark: 27717]Features Using Workflows 
 
        
        
         
         	 
           
           [bookmark: pgfId-3049276]Feature 
          
  
         	 
           
           [bookmark: pgfId-3049278]Menu Path 
          
  
         	 
           
           [bookmark: pgfId-3049280]Option 
          
  
        
 
         
         	[bookmark: pgfId-3049282]Intrusion events
  
         	[bookmark: pgfId-3049286]Analysis > Intrusions
  
         	[bookmark: pgfId-3049289]Events
 [bookmark: pgfId-3049290]Reviewed Events
 [bookmark: pgfId-3049291]Clipboard
 [bookmark: pgfId-3053269]Incidents
  
        
 
         
         	[bookmark: pgfId-3097867]Malware events
  
         	[bookmark: pgfId-3097869]Analysis > Files
  
         	[bookmark: pgfId-3097871]Malware Events
  
        
 
         
         	[bookmark: pgfId-3122725]File events
  
         	[bookmark: pgfId-3122727]Analysis > Files
  
         	[bookmark: pgfId-3122729]File Events
  
        
 
         
         	[bookmark: pgfId-3181821]Captured files
  
         	[bookmark: pgfId-3181823]Analysis > Files
  
         	[bookmark: pgfId-3181825]Captured Files
  
        
 
         
         	[bookmark: pgfId-3049607]Connection events
  
         	[bookmark: pgfId-3049609]Analysis > Connections
  
         	[bookmark: pgfId-3049611]Events
  
        
 
         
         	[bookmark: pgfId-3181910]Security Intelligence events
  
         	[bookmark: pgfId-3181912]Analysis > Connections
  
         	[bookmark: pgfId-3181914]Security Intelligence Events
  
        
 
         
         	[bookmark: pgfId-3049296]Host events
  
         	[bookmark: pgfId-3049300]Analysis > Hosts
  
         	[bookmark: pgfId-3049304]Network Map
 [bookmark: pgfId-3053300]Hosts
 [bookmark: pgfId-3194647]Indications of Compromise
 [bookmark: pgfId-3049975]Applications
 [bookmark: pgfId-3061727]Application Details
 [bookmark: pgfId-3061742]Servers
 [bookmark: pgfId-3050089]Host Attributes
 [bookmark: pgfId-3049310]Discovery Events
  
        
 
         
         	[bookmark: pgfId-3049315]User events
  
         	[bookmark: pgfId-3049319]Analysis > Users
  
         	[bookmark: pgfId-3049322]User Activity
 [bookmark: pgfId-3049326]Users
  
        
 
         
         	[bookmark: pgfId-3050452]Vulnerability events
  
         	[bookmark: pgfId-3050454]Analysis > Vulnerabilities
  
         	[bookmark: pgfId-3050456]Vulnerabilities
 [bookmark: pgfId-3050507]Third-Party Vulnerabilities
  
        
 
         
         	[bookmark: pgfId-3049328]Correlation events
  
         	[bookmark: pgfId-3049330]Analysis > Correlation 
  
         	[bookmark: pgfId-3049332]Correlation Events
 [bookmark: pgfId-3049336]White List Events
 [bookmark: pgfId-3049340]White List Violations
 [bookmark: pgfId-3050651]Status
  
        
 
         
         	[bookmark: pgfId-3049348]Audit events
  
         	[bookmark: pgfId-3049350]System > Monitoring
  
         	[bookmark: pgfId-3049352]Audit
  
        
 
         
         	[bookmark: pgfId-3049354]Health events
  
         	[bookmark: pgfId-3049356]Health > Health Events
  
         	[bookmark: pgfId-3049358]n/a
  
        
 
         
         	[bookmark: pgfId-3049363]Rule Update Import Log
  
         	[bookmark: pgfId-3049367]System > Updates
  
         	[bookmark: pgfId-3049373]n/a
  
        
 
         
         	[bookmark: pgfId-3049375]Scan Results
  
         	[bookmark: pgfId-3049377]Policies > Actions > Scanners
  
         	[bookmark: pgfId-3049379]n/a
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2675310]When you view any of the kinds of data described in the above table, events appear on the first page of the default workflow for that data.
 
     [bookmark: pgfId-2653816]Also note that workflow access depends on your user role (see Configuring User Roles), as follows:
 
      
      	 [bookmark: pgfId-2653677]Administrator users can access any workflow, and are the only users who can access the audit log, scan results, and the rule update import log.
 
      	 [bookmark: pgfId-2713006]Maintenance Users can access health events.
 
      	 [bookmark: pgfId-3053451]Security Analyst and Security Analyst (Read Only) users can access intrusion, malware, file, connection, discovery, vulnerability, correlation, and health workflows.
 
     
 
     [bookmark: pgfId-1840407]To view the data using a workflow other than the default:
 
     [bookmark: pgfId-2637326]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1840408]Step 1 Select the appropriate menu path and option as described in the Features Using Workflows table.
 
     [bookmark: pgfId-3061781]The first page of the default workflow for that data type appears. For information on specifying a different default workflow, see Configuring Event View Settings.
 
     [bookmark: pgfId-3061785]Step 2 Optionally, use a different workflow. Click (switch workflow) next to the workflow title, then select the workflow you want to use.
 
     [bookmark: pgfId-3253522]Step 3 The first page of your selected workflow appears.
 
     [bookmark: pgfId-3253550]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3253525][bookmark: 60392]Understanding the[bookmark: marker-3253524] Workflow Toolbar
 
     [bookmark: pgfId-3253529]License: Any
 
     [bookmark: pgfId-1841084]Each page in a workflow includes a toolbar that offers quick access to related features. The following table describes each of the links on the toolbar.
 
     [bookmark: pgfId-1841152]
 
      
       
        
        [bookmark: pgfId-1841098]Table 58-21 [bookmark: 16130]Workflow Toolbar Links 
 
        
        
         
         	 
           
           [bookmark: pgfId-1841102]Feature 
          
  
         	 
           
           [bookmark: pgfId-1841104]Description 
          
  
        
 
         
         	[bookmark: pgfId-1841109]Bookmark This Page
  
         	[bookmark: pgfId-1841111]Bookmarks the current page so you can return to it later. Bookmarking captures the constraints in effect on the page you are viewing so you can return to the same data (assuming the data still exists) at a later time. See Using Bookmarks for information about creating bookmarks.
  
        
 
         
         	[bookmark: pgfId-1841119]Report Designer
  
         	[bookmark: pgfId-1841121]Opens the report designer with the currently constrained workflow as the selection criteria. See Creating a Report Template from an Event View for information about creating reports.
  
        
 
         
         	[bookmark: pgfId-3119534]Dashboard
  
         	[bookmark: pgfId-3119536]Opens a dashboard relevant to your current workflow. For example, Connection Events workflows link to the Connection Summary dashboard. See Using Dashboards for information about using dashboards.
  
        
 
         
         	[bookmark: pgfId-1841136]View Bookmarks
  
         	[bookmark: pgfId-1841138]Displays a list of saved bookmarks from which you can select. See Using Bookmarks for information about creating and managing bookmarks.
  
        
 
         
         	[bookmark: pgfId-1841146]Search
  
         	[bookmark: pgfId-1841148]Displays a Search page where you can perform advanced searches on data in the workflow. You can also click the down arrow icon to select and use a saved search. See Searching for Events for information about searching workflows.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1841154][bookmark: 72076]Using Workflow Pages
 
     [bookmark: pgfId-2996399]License: Any
 
     [bookmark: pgfId-2365553]The actions you can perform on a workflow page depend on the type of page. Table view pages and drill-down pages contain many features you can use to constrain the set of events you want to view or to navigate the workflow. For more information on the features available on each type of page, see the following sections:
 
      
      	 [bookmark: pgfId-2365608]Using Common Table View or Drill-Down Page Functionality
 
      	 [bookmark: pgfId-3149605]Using Geolocation
 
      	 [bookmark: pgfId-2365922]Using Table View Pages
 
      	 [bookmark: pgfId-2365935]Using Drill-Down Pages
 
      	 [bookmark: pgfId-3127815]Using the Host View, Packet View, or Vulnerability Detail Pages
 
     
 
    
 
     
      [bookmark: pgfId-3127819][bookmark: 24652]Using Common Table View or[bookmark: marker-3127818] Drill-Down Page Functionality
 
     [bookmark: pgfId-3127820]License: Any
 
     [bookmark: pgfId-2363257]Table view and drill-down workflow pages provide a set of icons and other features in the table header and table rows that you can use to perform actions on the displayed data.
 
     [bookmark: pgfId-2125727]The features are described in the following table.
 
     [bookmark: pgfId-3148845]
 
      
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      
 
      [bookmark: pgfId-3148823]To remove a single constraint, click it. To remove a compound constraint, click Compound Constraints.
 
      [bookmark: pgfId-3148824]Click Edit Search or Save Search to open a search page pre-populated with the current single constraints. See Constraining Events for more information. 
 
      [bookmark: pgfId-3148828] 
      
 
       
        
        [bookmark: pgfId-3148749]Table 58-22 [bookmark: 88066]Table View and Drill-Down Page Features 
 
        
        
         
         	 
           
           [bookmark: pgfId-3148753]Feature 
          
  
         	 
           
           [bookmark: pgfId-3148755]Description 
          
  
        
 
        
           
         	[bookmark: pgfId-3148762]Click the blue down-arrow icon to display the corresponding row in the next page of the workflow.
  
        
 
        
          (clean) (malware) (custom detection) (unknown) (unavailable) 
         	[bookmark: pgfId-3176804]Click the network file trajectory icon, which appears in file name and SHA-256 hash value columns, to view the file’s trajectory map in a new window. For more information, see Analyzing Network File Trajectory.
 [bookmark: pgfId-3177047]Note that because the DC500 Defense Center, Series 2 devices, and Cisco NGIPS for Blue Coat X-Series do not support advanced malware protection, you cannot view network file trajectory for network-based malware and file events on these appliances.
  
        
 
        
           (potentially compromised) (blacklisted) (blacklisted, set to monitor) 
         	[bookmark: pgfId-3148778]Click the[bookmark: marker-3148777] host profile icon, which appears in IP address columns, to display the host profile associated with that IP address in a pop-up window. For more information, see Using Host Profiles. 
 [bookmark: pgfId-3196577]Hosts that have been tagged as potentially compromised by triggered indications of compromise (IOC) rules appear with the compromised host icon instead of the usual icon. For more information on IOC, see Understanding Indications of Compromise.
 [bookmark: pgfId-3148782]If the host profile icon is grayed out, you cannot view the host profile because that host cannot be in the network map (for example, 0.0.0.0).
 [bookmark: pgfId-3173806]If you are performing traffic filtering based on Security Intelligence data, host icons next to blacklisted and monitored IP addresses in the connection event view look slightly different. This helps you identify which host in a connection was blacklisted. Note that neither the DC500 Defense Center nor Series 2 devices support Security Intelligence data.
  
        
 
        
          (Low threat score) (Medium threat score) (High threat score) (Very High threat score) 
         	[bookmark: pgfId-3183668]Click the threat score icon, which appears in threat score columns, to view the Dynamic Analysis Summary report for the highest threat score associated with a file.
 [bookmark: pgfId-3183644]Note that because the DC500 Defense Center, Series 2 devices, and Cisco NGIPS for Blue Coat X-Series support advanced malware protection, you cannot view the Dynamic Analysis Summary report on these appliances.
  
        
 
        
           
         	[bookmark: pgfId-3148790]Click the user icon, which appears in user identity columns, to view user profile information. For more information, see Understanding User Details and Host History.
 [bookmark: pgfId-3148795]If the u[bookmark: marker-3148794]ser icon is grayed out, you cannot view the user profile because that user cannot be in the database (FireAMP Connector user).
  
        
 
        
           
         	[bookmark: pgfId-3148805]Click the vulnerability icon, which appears in third-party vulnerability ID columns, to view vulnerability details for third-party vulnerabilities. For more information, see Viewing Vulnerability Details.
  
        
 
         
         	[bookmark: pgfId-3148810]Check boxes
  
         	[bookmark: pgfId-3148812]Select the check boxes by two or more rows on a page to indicate which rows you want to affect, then click one of the buttons at the bottom of the page (for example, the View button). You can also select the check box at the top of the row to select all the rows on the page.
  
        
 
         
         	[bookmark: pgfId-3153717]Country flags and codes
  
         	[bookmark: pgfId-3153719]In some workflow pages, such as those for connection events, intrusion events, file events, and malware events, routable IP addresses include information about the associated country. When this geolocation information is available, the country’s flag and ISO code appear in the appropriate column (such as Source Country). Hover your pointer over the flag to view the country name. When viewing individual (rather than aggregated) data points, you can click the flag icon to view further geolocation details. See Using Geolocation for more information.
 [bookmark: pgfId-3173927]Note that the DC500 Defense Center does not support geolocation data.
  
        
 
         
         	[bookmark: pgfId-3148814]Search Constraints
  ) to hide the list from view. By default, this list is collapsed, which is useful when the list of constraints is long and takes up too much of the screen. Note Compound constraints are constraints created based on rows with multiple non-count values. You cannot perform a search or save a search on a compound constraint. 
        
 
         
         	[bookmark: pgfId-3148830]Time Range
  
         	[bookmark: pgfId-3148832]The date range located in the upper right corner of the page sets a time range for events to include in the workflow. See Setting Event Time Constraints for more information.
 [bookmark: pgfId-3148836]Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.
  
        
 
         
         	[bookmark: pgfId-3148838]Workflow Page Links
  
         	[bookmark: pgfId-3148840]Workflow page links appear in the upper left corner of predefined workflow table view and drill-down pages, above events and below the workflow name. Click a workflow page link to display that page using any active constraints.
  
        
 
         
         	[bookmark: pgfId-3148842]Workflow Name
  
         	[bookmark: pgfId-3148844]The name of the workflow appears at the top of the page. Beside it, when applicable, is the (switch workflows) link, which you can use to select other workflows of the same type.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-3148848][bookmark: 82561]Using Ge[bookmark: marker-3200593]olocation
 
     [bookmark: pgfId-3149253]License: FireSIGHT
 
     [bookmark: pgfId-3195527]Supported Devices: feature dependent
 
     [bookmark: pgfId-3154851]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-3149273]While monitoring your network, the geolocation feature provides you with additional data about the geographical sources of routable IP addresses (country, continent, and so on). You can use this data to determine if, for example, connections are originating from or terminating in countries unconnected with your organization. 
 
     [bookmark: pgfId-3209286]Geolocation information is available for intrusion events, connection events, file events, malware events, host profiles, and user profiles. Geolocation information is also available in the Context Explorer and the dashboard. 
 
     [bookmark: pgfId-3222303]You can use geolocation data (source and destination country/continent) as conditions for access control rules, as well as create custom geolocation objects for this purpose. You can also use source/destination country data as conditions for correlation rules and traffic profiles. For more information, see Working with Geolocation Objects, Controlling Traffic by Network or Geographical Location, Creating Rules for Correlation Policies, and Specifying Traffic Profile Conditions.
 
     [bookmark: pgfId-3155210]By installing geolocation database (GeoDB) updates, you can view a Geolocation Details page with granular information available for an IP address, such as postal code, coordinates, time zone, Autonomous System Number (ASN), Internet service provider (ISP), use type (home or business), organization, domain name, connection type, and proxy information. You can also pinpoint the detected location with any of four third-party map tools. Without a GeoDB update, only the flag icon and country name appear; you cannot view the Geolocation Details page. For information on installing and updating the GeoDB, see Updating the Geolocation Database. You can view the current version of your GeoDB update by clicking Help > About.
 
      
       
        
        [bookmark: pgfId-3157410]Table 58-23 [bookmark: 37257]Geolocation Detail Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-3157414]Field 
          
  
         	 
           
           [bookmark: pgfId-3157416]Contents 
          
  
        
 
         
         	[bookmark: pgfId-3157418]Country
  
         	[bookmark: pgfId-3157420]Country associated with the host’s IP address, accompanied by the country’s flag. The continent is listed in parentheses. Examples: United States (North America), Equatorial Guinea (Africa)
  
        
 
         
         	[bookmark: pgfId-3157422]Region
  
         	[bookmark: pgfId-3157424]State, province, or other subregion of the country where the host is located. Examples: VA, 35
  
        
 
         
         	[bookmark: pgfId-3157426]City
  
         	[bookmark: pgfId-3157428]City where the host is located. Examples: Seattle, Fukuoka
  
        
 
         
         	[bookmark: pgfId-3157430]Postal Code
  
         	[bookmark: pgfId-3157432]Postal code of the region where the host is located. Examples: 361000, 90210
  
        
 
         
         	[bookmark: pgfId-3157434]Latitude/Longitude
  
         	[bookmark: pgfId-3157436]Exact coordinates of the host’s location. Examples: 40.0375, -76.1053; 53.4050, -0.5484
  
        
 
         
         	[bookmark: pgfId-3157438]Maps
  
         	[bookmark: pgfId-3157440]Links to external mapping sites (Google Maps, Yahoo Maps, Bing Maps, and OpenStreetMap). Click any link to view a contextual map of the host’s approximate location.
  
        
 
         
         	[bookmark: pgfId-3157442]Timezone
  
         	[bookmark: pgfId-3157444]Time zone of the host’s location, with Daylight Savings Time noted where applicable. Examples: GMT+8:00, GMT-4:00 (In DST)
  
        
 
         
         	[bookmark: pgfId-3157446]ASN
  
         	[bookmark: pgfId-3157448]Autonomous System Number (ASN) associated with the host’s IP address, and any additional information about that ASN. Examples: 14618 (Amazon.com Inc.); 4837 (Cncgroup China169 Backbone)
  
        
 
         
         	[bookmark: pgfId-3157450]ISP
  
         	[bookmark: pgfId-3157452]Internet service provider (ISP) associated with the host’s IP address. Examples: Atlantic Broadband; China Unicom Ip Network
  
        
 
         
         	[bookmark: pgfId-3157454]Home/Business
  
         	[bookmark: pgfId-3157456]Whether the host’s connection is used for Home or Business purposes.
  
        
 
         
         	[bookmark: pgfId-3157682]Organization
  
         	[bookmark: pgfId-3157684]Organization associated with the host’s IP address. Examples: Amazon.com, Bank of America
  
        
 
         
         	[bookmark: pgfId-3157678]Domain Name
  
         	[bookmark: pgfId-3157680]Domain name associated with the host’s IP address. Examples: amazonaws.com, xmcnc.net
  
        
 
         
         	[bookmark: pgfId-3157674]Connection Type
  
         	[bookmark: pgfId-3157676]Connection type associated with the host’s IP address. Examples: Broadband, DSL
  
        
 
         
         	[bookmark: pgfId-3157670]Proxy Type
  
         	[bookmark: pgfId-3157672]The type of proxy used. Examples: Anonymous, Corporate
  
        
 
        
      
 
     
 
     [bookmark: pgfId-3156948]To view geolocation details:
 
     [bookmark: pgfId-3160783]Access: Any
 
     
 
     [bookmark: pgfId-3160784]Step 1 In an event view, host profile, or other geolocation-supporting page, click the small country flag icon or ISO country code that appears by an individual data point. (You cannot view geolocation details for aggregate geolocation information, such as on the Connection Summary dashboard, despite the presence of flag icons.)
 
      
       
     
 
     
 
     [bookmark: pgfId-3161043]Tip In event views, hover your pointer over the flag icon to view a tooltip with the country’s name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3253432]The Geolocation Details page appears in a new window.
 
     [bookmark: pgfId-3253476]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3253435][bookmark: 93679]Using Table View[bookmark: marker-3253434] Pages
 
     [bookmark: pgfId-3253439]License: Any
 
     [bookmark: pgfId-2365194]Table views include a column for each of the fields in the database if the column is enabled by default. Note that when you disable a column on a table view, the FireSIGHT System adds the Count column to the event view if disabling the column would create two or more identical rows. When you click on a value in a table view page, you constrain by that value. When you create a custom workflow, you add a table view to it by clicking Add Table View.
 
      
      
 
       
        
        [bookmark: pgfId-3253347]Table 58-24 [bookmark: 41120]Additional Table View Page Features 
 
        
        
         
         	 
           
           [bookmark: pgfId-3253351]Feature 
          
  
         	 
           
           [bookmark: pgfId-3253353]Description 
          
  
        
 
        
           
         	[bookmark: pgfId-3253360]Click this icon in the column heading that you want to hide. In the pop-up window that appears, click Apply.
 .  
        
 
         
         	[bookmark: pgfId-3253363]Disabled Columns list
  
         	[bookmark: pgfId-3253365]When you remove columns from a page, or columns are disabled by default, the column names appear in the Disabled Columns list, which is located above the table and hidden by default.
 ) to expand the search constraints, then click the column name under Disabled Columns.
 [bookmark: pgfId-3253373]See Sorting Drill-Down Workflow Pages for more information.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2377677][bookmark: 73170]Using Drill-Down Pages
 
     [bookmark: pgfId-2996478]License: Any
 
     [bookmark: pgfId-2377678]Drill-down pages contain a subset of columns that are available in the database. Note that drill-down pages for predefined workflows always have a Count column. Drill-down pages allow you to narrow the scope of events you are viewing and to move forward in the workflow. If you click on a value in a drill-down page, for example, you constrain by that value and move to the next page in the workflow, focusing more closely on events that match your selected values. Clicking a value in a drill-down page does not disable the column where the value is, even if the page you advance to is a table view. When you create a custom workflow, you add a drill-down page to it by clicking Add Page.
 
     [bookmark: pgfId-2366246]For more information on using features on drill-down pages to constrain the set of events as you go through a workflow, see Using Common Table View or Drill-Down Page Functionality.
 
    
 
     
      [bookmark: pgfId-2365306][bookmark: 46947]Using the Host View, Packet View, or Vulnerability Detail Pages
 
     [bookmark: pgfId-2996501]License: Any
 
     [bookmark: pgfId-2369416]The final page in a discovery event, host, host attributes, indications of compromise, servers, client applications, or connection data workflow is the host view. The final page in a vulnerability workflow is the vulnerability detail page. An intrusion event workflow always ends with the packet view. On the final page of a workflow, you can expand detail sections to view specific information about each object in the set you focused on over the course of the workflow. Although the web interface does not list the constraints on the final page of a workflow, previously set constraints are retained and applied to the set of data.
 
    
 
     
      [bookmark: pgfId-2369423][bookmark: 50753]Setting Event Time[bookmark: marker-2369418] Const[bookmark: Time]raints
 
     [bookmark: pgfId-2996536]License: Any
 
     [bookmark: pgfId-2655384]Each event has a time stamp that indicates when the event occurred. You can constrain the information that appears in some workflows by setting the time window, sometimes called the time range.
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3241037]By default, workflows on Cisco appliances use an expanding time window set to the past hour. For example, if you log in at 11:30 AM, you will see events that occurred between 10:30 AM and 11:30 AM. As time moves forward, the time window expands. At 12:30 PM, you will see events that occurred between 10:30 AM and 12:30 PM.
 
     [bookmark: pgfId-2701833]You can change this behavior by setting your own default time window, which governs three properties: 
 
      
      	 [bookmark: pgfId-2714739]time window type (static, expanding, or sliding)
 
      	 [bookmark: pgfId-2714743]time window length
 
      	 [bookmark: pgfId-2714744]the number of time windows (either multiple time windows or a single global time window) 
 
     
 
     [bookmark: pgfId-2714745]For general information on the default time window, see Default Time Windows.
 
     [bookmark: pgfId-2701850]Regardless of the default time window setting, you can manually change the time window during your event analysis by clicking the time range at the top of the page, which displays the Date/Time pop-up window. Depending on the number of time windows you configured and the type of appliance you are using, you can also use the Date/Time window to change the default time window for the type of event you are viewing.
 
     [bookmark: pgfId-2714772]Finally, you can pause the time window, which allows you to examine the data provided by the workflow without the time window changing and removing or adding events that you are not interested in. Note that to avoid displaying the same events on different workflow pages, the time window automatically pauses when you click a link at the bottom of the page to display another page of events; you can unpause the time window when you are ready.
 
     [bookmark: pgfId-2701016]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-2701001]Changing the Time Window
 
      	 [bookmark: pgfId-2702660]Changing the Default Time Window for Your Event Type
 
      	 [bookmark: pgfId-2702689]Pausing the Time Window
 
     
 
    
 
     
      [bookmark: pgfId-2700975][bookmark: 96982]Changing the [bookmark: marker-2764030]Time Window
 
     [bookmark: pgfId-3056364]License: Any
 
     [bookmark: pgfId-2700976]Regardless of the default time window, you can manually change the time window during your event analysis.
 
      
       
     
 
     
 
     [bookmark: pgfId-2714787]Note Manual time window settings are valid for only the current session. When you log out and then log back in, time windows are reset to the default. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2702779]Depending on the number of time windows you configured, changing the time window for one workflow may affect other workflows on the appliance. For example, if you have a single, global time window, changing the time window for one workflow changes it for all other workflows on the appliance. On the other hand, if you are using multiple time windows, changing the audit log or health event workflow time windows has no effect on any other time window, while changing the time window for other kinds of events affects all events that can be constrained by time (with the exception of audit events and health events).
 
     [bookmark: pgfId-2745711]Note that because not all workflows can be constrained by time, time window settings have no effect on workflows based on hosts, host attributes, applications, application details, vulnerabilities, users, or white list violations.
 
     [bookmark: pgfId-2745715]Use the Time Window tab on the Date/Time window to manually configure a time window. Depending on the number of time windows you configured in your default time window settings, the tab’s title is one of the following:
 
      
      	 [bookmark: pgfId-2690274] Events Time Window , if you configured multiple time windows and are setting the time window for a workflow other than the audit log or health events workflow
 
      	 [bookmark: pgfId-2690437] Health Monitoring Time Window , if you configured multiple time windows and are setting the time window for the health events workflow
 
      	 [bookmark: pgfId-2690348] Audit Log Time Window , if you configured multiple time windows and are setting the time window for the audit log
 
      	 [bookmark: pgfId-2690374] Global Time Window , if you configured a single time window
 
     
 
     [bookmark: pgfId-2695778]The first decision you must make when configuring a time window is the type of time window you want to use: 
 
      
      	 [bookmark: pgfId-2702872]A  static time window displays all the events generated from a specific start time to a specific end time.
 
      	 [bookmark: pgfId-2702873]An  expanding time window displays all the events generated from a specific start time to the present; as time moves forward, the time window expands and new events are added to the event view.
 
      	 [bookmark: pgfId-2702874]A  sliding time window displays all the events generated from a specific start time (for example, one week ago) to the present; as time moves forward, the time window “slides” so that you see only the events for the range you configured (in this example, for the last week).
 
     
 
      
      [image: ] 
     
 
      
      [image: ] 
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     [bookmark: pgfId-2695909]Note The FireSIGHT System uses a 24-hour clock based on the time you specified in your time zone preferences. See Setting Your Default Time Zone for information about configuring a time zone.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-2692742]Table 58-25 [bookmark: 90661]Time Window Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-2692746]Setting 
          
  
         	 
           
           [bookmark: pgfId-2693223]Time Window Type 
          
  
         	 
           
           [bookmark: pgfId-2692748]Description 
          
  
        
 
         
         	[bookmark: pgfId-2692750]time window type drop-down list
  
         	[bookmark: pgfId-2693225]n/a
  
         	[bookmark: pgfId-2692752]Select the type of time window you want to use: static, expanding, or sliding.
 [bookmark: pgfId-2746214]Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.
  
        
 
         
         	[bookmark: pgfId-2692754]Start Time calendar
  
         	[bookmark: pgfId-2693227]static and expanding
  
         	[bookmark: pgfId-2692756]Specify a start date and time for your time window. The maximum time range for all time windows is from midnight on January 1, 1970 (UTC) to 3:14:07 AM on January 19, 2038 (UTC).
 [bookmark: pgfId-2696038]Tip Instead of using the calendar, you can use the Presets options, described below.  
        
 
         
         	[bookmark: pgfId-2692758]End Time calendar
  
         	[bookmark: pgfId-2693229]static
  
         	[bookmark: pgfId-2714815]Specify an end date and time for your time window. The maximum time range for all time windows is from midnight on January 1, 1970 (UTC) to 3:14:07 AM on January 19, 2038 (UTC).
 [bookmark: pgfId-2714816]Note that If you are using an expanding time window, the End Time calendar is grayed out and specifies that the end time is “Now.”
 [bookmark: pgfId-2696137]Tip Instead of using the calendar, you can use the Presets options, described below.  
        
 
         
         	[bookmark: pgfId-2693262]Show the Last field and drop-down list 
  
         	[bookmark: pgfId-2693264]sliding
  
         	[bookmark: pgfId-2693266]Configure the length of the sliding time window.
  
        
 
         
         	[bookmark: pgfId-2692762]Presets: Last
  
         	[bookmark: pgfId-2693231]all
  
         	[bookmark: pgfId-2692764]Click one of the time ranges in the list to change the time window, based on the local time of the appliance. For example, clicking 1 week changes the time window to reflect the last week. Clicking a preset changes the calendars to reflect the preset you choose.
  
        
 
         
         	[bookmark: pgfId-2692766]Presets: Current
  
         	[bookmark: pgfId-2693233]static and expanding
  
         	[bookmark: pgfId-2714842]Click one of the time ranges in the list to change the time window, based on the local time and date of the appliance. Clicking a preset changes the calendars to reflect the preset you choose.
 [bookmark: pgfId-2692768]Note that:
 
           
           	 [bookmark: pgfId-2696463]the current day begins at midnight
 
           	 [bookmark: pgfId-2696562]the current week begins at midnight Sunday
 
           	 [bookmark: pgfId-2696612]the current month begins at midnight on the first of the month
 
          
  
        
 
         
         	[bookmark: pgfId-2692770]Presets: Synchronize with
  
         	[bookmark: pgfId-2693235]all (not available if you are using a global time window)
  
         	[bookmark: pgfId-2692772]Click one of:
 
           
           	 [bookmark: pgfId-2696681] Events Time Window to synchronize the current time window with the events time window
 
           	 [bookmark: pgfId-2696688] Health Monitoring Time Window to synchronize the current time window with the health monitoring time window
 
           	 [bookmark: pgfId-2696689] Audit Log Time Window to synchronize the current time window with the audit log time window
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2703614]To change the time window during event analysis:
 
     [bookmark: pgfId-3084507]Access: Admin/Maint/Any Security Analyst
 
     
 ). 
     
 
     [bookmark: pgfId-3084512]The Date/Time window appears.
 
     [bookmark: pgfId-3084444]Step 2 On the Time Window tab, set the time window as described in the Time Window Settings table.
 
      
       
     
 
     
 
     [bookmark: pgfId-2703622]Tip Click Reset to change the time window back to the default settings.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2703623]Step 3 Click Apply.
 
     [bookmark: pgfId-2703624]The window closes and the event view page displays events from the new time range.
 
     [bookmark: pgfId-3253118]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2703612][bookmark: 21532]Changing the Defau[bookmark: marker-2764038]lt Time Window for Your Event Type
 
     [bookmark: pgfId-3056380]License: Any
 
     [bookmark: pgfId-2703793]During your event analysis, you can use the Preferences tab on the Date/Time window to change the default time window for the type of event you are viewing without having to use the event view settings (see Default Time Windows).
 
     [bookmark: pgfId-2690524]Keep in mind that changing the default time window in this way changes the default time window for only the type of event you are viewing. For example, if you configured multiple time windows, changing the default time window on the Preferences tab changes the settings for either the events, health monitoring, or audit log window, in other words, whichever time window is indicated by the first tab. If you configured a single time window, changing the default time window on the Preferences tab changes the default time window for all types of events.
 
     [bookmark: pgfId-3289971]The following graphic shows the Defense Center version of the Preferences tab, on an appliance that has multiple time windows configured.
 
     [bookmark: pgfId-3289975]
 
      
      [image: ] 
     
 
      
       
        
        [bookmark: pgfId-2705044]Table 58-26 [bookmark: 34808]Time Window Preferences 
 
        
        
         
         	 
           
           [bookmark: pgfId-2705048]Preference 
          
  
         	 
           
           [bookmark: pgfId-2705050]Description 
          
  
        
 
         
         	[bookmark: pgfId-2705053]Refresh[bookmark: marker-2705052] Interval
  
         	[bookmark: pgfId-2705055]Sets the refresh interval for event views, in minutes. Entering zero disables the refresh option.
  
        
 
         
         	[bookmark: pgfId-2705057]Number of Time Windows
  
         	[bookmark: pgfId-2705059]Specify how many time windows you want to use:
 
           
           	 [bookmark: pgfId-2705060]Select  Multiple to configure separate default time windows for the audit log, for health events, and for workflows based on events that can be constrained by time.
 
           	 [bookmark: pgfId-2705061]Select  Single to use a global time window that applies to all events,
 
          
  
        
 
         
         	[bookmark: pgfId-2705063]Default Time Window: Show the Last - Sliding
  
         	[bookmark: pgfId-2705065]This setting allows you to configure a sliding default time window of the length you specify.
 [bookmark: pgfId-2705066]The appliance displays all the events generated from a specific start time (for example, 1 hour ago) to the present. As you change event views, the time window “slides” so that you always see events from the last hour.
  
        
 
         
         	[bookmark: pgfId-2705068]Default Time Window: Show the Last - Static/Expanding
  
         	[bookmark: pgfId-2705070]This setting allows you to configure either a static or expanding default time window of the length you specify.
 [bookmark: pgfId-2705071]For static time windows (enable the Use End Time check box), the appliance displays all the events generated from a specific start time (for example, 1 hour ago), to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.
 [bookmark: pgfId-2705072]For expanding time windows (disable the Use End Time check box), the appliance displays all the events generated from a specific start time (for example, 1 hour ago), to the present. As you change event views, the time window expands to the present time.
  
        
 
         
         	[bookmark: pgfId-2705074]Default Time Window: Current Day - Static/Expanding
  
         	[bookmark: pgfId-2705076]This setting allows you to configure either a static or expanding default time window for the current day. The current day begins at midnight, based on the time zone setting for your current session.
 [bookmark: pgfId-2705077]For static time windows (enable the Use End Time check box), the appliance displays all the events generated from midnight to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.
 [bookmark: pgfId-2705078]For expanding time windows (disable the Use End Time check box), the appliance displays all the events generated from midnight to the present. As you change event views, the time window expands to the present time. Note that if your analysis continues for over 24 hours before you log out, this time window can be more than 24 hours.
  
        
 
         
         	[bookmark: pgfId-2705080]Default Time Window: Current Week - Static/Expanding
  
         	[bookmark: pgfId-2705082]This setting allows you to configure either a static or expanding default time window for the current week. The current week begins at midnight on the previous Sunday, based on the time zone setting for your current session.
 [bookmark: pgfId-2705083]For static time windows (enable the Use End Time check box), the appliance displays all the events generated from midnight to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.
 [bookmark: pgfId-2705084]For expanding time windows (disable the Use End Time check box), the appliance displays all the events generated from midnight Sunday to the present. As you change event views, the time window expands to the present time. Note that if your analysis continues for over 1 week before you log out, this time window can be more than 1 week.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2705763]To change time window preferences during event analysis:
 
     [bookmark: pgfId-2705764]Access: Admin/Maint/Any Security Analyst
 
     
 ). 
     
 
     [bookmark: pgfId-2705766]The Date/Time window appears.
 
     [bookmark: pgfId-2705769]Step 2 Select the Preferences tab and change your preferences, as described in the Time Window Preferences table.
 
     [bookmark: pgfId-2705771]Step 3 Click Save Preferences.
 
     [bookmark: pgfId-2705772]Your preferences are saved.
 
     [bookmark: pgfId-2705773]Step 4 You have two options:
 
      
       
       	 [bookmark: pgfId-2705774]To apply your new default time window settings to the event view you are using, click  Apply to close the Date/Time window and refresh the event view.
 
       	 [bookmark: pgfId-2705775]To continue with your analysis without applying the default time window settings, close the Date/Time window without clicking  Apply .
 
      
 
     
 
     [bookmark: pgfId-3253098]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2705629][bookmark: 55218]Pausing the Time[bookmark: marker-2764039] Window
 
     [bookmark: pgfId-2996628]License: Any
 
     [bookmark: pgfId-2725181]You can pause the time window, which allows you to examine a snapshot of the data provided by the workflow. This is useful because when an unpaused workflow updates, it may remove events that you want to examine or add events that you are not interested in. 
 
     [bookmark: pgfId-2725192]Note that you cannot pause a static time window. In addition, pausing an event time window has no effect on dashboards, nor does pausing a dashboard have any effect on pausing an event time window.
 
     [bookmark: pgfId-2724729]When you are finished with your analysis, you can unpause the time window. Unpausing the time window updates it according to your preferences, and also updates the event view to reflect the unpaused time window.
 
     [bookmark: pgfId-2724947]If the database contains more events than can be displayed on a single workflow page, you can click the links at the bottom of the page to display more events (see Navigating to Other Pages in the Workflow). When you do this, the time window automatically pauses so that you do not see the same events twice. You can unpause the time window when you are ready.
 
     [bookmark: pgfId-2706540]To pause the time window:
 
     [bookmark: pgfId-2706541]Access: Admin/Maint/Any Security Analyst
 
     
 ). 
     
 
     [bookmark: pgfId-2706546]The time window is paused until you unpause it.
 
     [bookmark: pgfId-3253076]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2706547]To unpause the time window:
 
     [bookmark: pgfId-2706548]Access: Admin/Maint/Any Security Analyst
 
     
 ). 
     
 
     [bookmark: pgfId-2706553]The time window is unpaused and updates according to your preferences. The event view updates to reflect the current time window.
 
     [bookmark: pgfId-3253061]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1841835][bookmark: 23537]Constraining[bookmark: marker-2400845] E[bookmark: ConstrainingEvents]vents
 
     [bookmark: pgfId-2996692]License: Any
 
     [bookmark: pgfId-2011083]The information that you see on a workflow page is determined by the constraints that you impose. For example, when you initially open an event workflow, the information is constrained to events that were generated in the previous hour.
 
     [bookmark: pgfId-1972014]To advance to the next page in the workflow and constrain the data you are viewing by specific values, select the rows with those values on the page and click View. To advance to the next page in the workflow retaining the current constraints and carrying forward all events, select View All.
 
      
       
     
 
     
 
     [bookmark: pgfId-1840448]Note If you select a row with multiple non-count values and click View, you create a compound constraint. For more information on compound constraints, see Using Compound Constraints.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3151934]There is a third method for constraining data in a workflow. To constrain the page to the rows with values that you selected and also add the selected value to the list of constraints at the top of the page, click a value within a row on the page.
 
     [bookmark: pgfId-3289980]For example, if you click 10.10.60.119 in the Initiator IP column on a page with the following events:
 
     [bookmark: pgfId-3289984]
 
      
      [image: ] 
     
 
     [bookmark: pgfId-3089725]You can also use searches to constrain the information in a workflow. The search criteria you enter on the search page are listed as the constraints at the top of the page, with the resulting events constrained accordingly. On the Defense Center, the current constraints are also applied when navigating to other workflows, unless they are compound constraints (see Navigating Between Workflows).
 
     [bookmark: pgfId-3012984]When searching, you must pay careful attention to whether your search constraints apply to the table you are searching. For example, client data is not available in connection summaries. If you search for connection events based on the detected client in the connection and then view the results in a connection summary event view, the Defense Center displays connection data as if you had not constrained it at all. Invalid constraints are labeled as not applicable (N/A) and are marked with a strikethrough.
 
      
      
 
       
        
        [bookmark: pgfId-2367126]Table 58-27 [bookmark: 35952]Search Constraint Functions 
 
        
        
         
         	 
           
           [bookmark: pgfId-2367130]To... 
          
  
         	 
           
           [bookmark: pgfId-2367132]Click... 
          
  
        
 
         
         	[bookmark: pgfId-2367134]constrain the view to events that match a single value
  
         	[bookmark: pgfId-3148352]the value in the table.
 [bookmark: pgfId-2367137]For example, if you are viewing a list of logged connections and want to constrain the list to only those you allowed using access control, click Allow in the Action column. As another example, if you are viewing intrusion events and want to constrain the list to only events where the destination port is 80, click 80 (http)/tcp in the DST Port/ICMP Code column.
  
        
 
         
         	[bookmark: pgfId-2367139]constrain the view to events that match multiple values
  
         	[bookmark: pgfId-2367141]the check box for events with those values and click View. 
 [bookmark: pgfId-2367394]Note that a compound constraint is added if the row contains multiple non-count values. For more information on compound constraints, see Using Compound Constraints.
  
        
 
         
         	[bookmark: pgfId-2367143]remove a constraint
  
         	[bookmark: pgfId-2367145]the name of the constraint in the Search Constraints box.
  
        
 
         
         	[bookmark: pgfId-2367147]edit constraints using the search page
  
         	[bookmark: pgfId-2367149]Edit Search in the Search Constraints box. 
 [bookmark: pgfId-2367150]Use this feature when you want to constrain against multiple values in a single column. For example, if you want to view the events related to two IP addresses, click Edit Search, then modify the appropriate IP address field on the Search page to include both addresses, and then click Search.
  
        
 
         
         	[bookmark: pgfId-2367152]save constraints as a saved search
  
         	[bookmark: pgfId-2367154]Save Search in the Search Constraints box and give the query a name.
 [bookmark: pgfId-2367650]Note that you cannot save queries containing compound constraints. For more information on compound constraints, see Using Compound Constraints.
  
        
 
         
         	[bookmark: pgfId-2367156]use the same constraints with another event view
  
         	[bookmark: pgfId-2367158]Jump to and select the event view. See Navigating Between Workflows for more information.
 [bookmark: pgfId-2367811]Note that you do not retain compound constraints when you switch to another workflow. For more information on compound constraints, see Using Compound Constraints.
  
        
 
         
         	[bookmark: pgfId-2367163]toggle the display of constraints
  ). This is useful when the list of constraints is large and takes up most of the screen. 
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3013030][bookmark: 71757]Using Compound[bookmark: marker-2400846] Constraints
 
    [bookmark: pgfId-2996731]License: Any
 
    [bookmark: pgfId-1843209]Compound constraints are based on all non-count values for a specific event. When you select a row with multiple non-count values, you set a compound constraint that only retrieves events matching all the non-count values in that row on that page. For example, if you select a row that has a source IP address of 10.10.31.17 and a destination IP address of 10.10.31.15 and a row that has a source IP address of 172.10.10.17 and a destination IP address of 172.10.10.15, you retrieve all of the following:
 
     
     	 [bookmark: pgfId-2368468]Events that have a source IP address of 10.10.31.17 AND a destination IP address of 10.10.31.15 
 
    
 
    [bookmark: pgfId-2368505]OR
 
     
     	 [bookmark: pgfId-2368520]Events that have a source IP address of 172.10.31.17 AND a destination IP address of 172.10.31.15 
 
    
 
    [bookmark: pgfId-2368534]When you combine compound constraints with simple constraints, the simple constraints are distributed across each set of compound constraints. If, for example, you added a simple constraint for a protocol value of tcp to the compound constraints listed above, you retrieve all of the following:
 
     
     	 [bookmark: pgfId-2368641]Events that have a source IP address of 10.10.31.17 AND a destination IP address of 10.10.31.15 AND a protocol of tcp
 
    
 
    [bookmark: pgfId-2368642]OR
 
     
     	 [bookmark: pgfId-2368643]Events that have a source IP address of 172.10.31.17 AND a destination IP address of 172.10.31.15 AND a protocol of tcp
 
    
 
    [bookmark: pgfId-2366893]You cannot perform a search or save a search on a compound constraint. You also cannot retain compound constraints when you use the event view links or click (switch workflow) to switch to another workflow. If you bookmark an event view with compound constraints applied, the constraints are not saved with the bookmark.
 
    [bookmark: pgfId-2368360]To clear all compound constraints, click Compound Constraints.
 
   
 
    
     [bookmark: pgfId-2737381][bookmark: 59648]Sorting Table View Pa[bookmark: ChangeLayout]ges[bookmark: marker-2737380] and Changing Their Layout
 
    [bookmark: pgfId-2996754]License: Any
 
    [bookmark: pgfId-2737384]When viewing data in a workflow, you can sort the data based on any available column and remove and restore columns to view. You can sort data in ascending or descending order by column.
 
     
      
    
 
    
 
    [bookmark: pgfId-2737385]Tip If you create a custom workflow, you can fully customize the arrangement of columns on the pages and predefine the page sort order. See Creating Custom Workflows for more information.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3104848]
 
      
      
 
      [bookmark: pgfId-3104838]When you disable a column, it is disabled for the duration of your session (unless you add it back later). Note that when you disable the first column, the Count column is added. You cannot disable the Count column.
 
       
        
        [bookmark: pgfId-3104816]Table 58-28 Sorting and Layout Functions 
 
        
        
         
         	 
           
           [bookmark: pgfId-3104820]To... 
          
  
         	 
           
           [bookmark: pgfId-3104822]Click... 
          
  
        
 
         
         	[bookmark: pgfId-3104824]sort a column
  
         	[bookmark: pgfId-3104826]the column title. Click the column title again to reverse the sort order.
 ) indicates which column the data is sorted by, and whether the sort is ascending (upward-pointing icon) or descending (downward-pointing icon).  
        
 
         
         	[bookmark: pgfId-3104832]remove a column from a table view
  . ) to expand the search constraints, then click the column name under Disabled Columns. 
        
 
         
         	[bookmark: pgfId-3104844]add a disabled column back to the view
  
         	[bookmark: pgfId-3104846]the column name under Disabled Columns.
 [bookmark: pgfId-3104847]When you enable a column that is disabled by default, it is enabled for the duration of your session (unless you disable it later). Note that the Count column is removed if enabling results in no identical rows.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3104852][bookmark: 55298]Sorting Drill-Down Workflow Pa[bookmark: SortDrilldown]ges[bookmark: marker-3104851] 
 
    [bookmark: pgfId-3104853]License: Any
 ) indicates which column the data is sorted by, and whether the sort is ascending (upward-pointing icon) or descending (downward-pointing icon). 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1822328]Tip If you create a custom workflow, you can fully customize the arrangement of columns on the pages and predefine the page sort order. See Creating Custom Workflows for more information.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2737710]To sort a column:
 
    [bookmark: pgfId-3082699]Access: Admin/Maint/Any Security Analyst
 
    
 
    [bookmark: pgfId-2737743]Step 1 Click the column title.
 
    [bookmark: pgfId-3252698]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2737772]To reverse the sort order:
 
    [bookmark: pgfId-3082708]Access: Admin/Maint/Any Security Analyst
 
    
 
    [bookmark: pgfId-2737852]Step 1 Click the column title again.
 
    [bookmark: pgfId-3252682]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2655789][bookmark: 93960]Selecting Rows on a Workflow Page
 
    [bookmark: pgfId-2996816]License: Any
 
    [bookmark: pgfId-2655790]There are several different ways to select and then act on the rows on workflow pages:
 
     
      [bookmark: pgfId-1843021]
 
      
      	 [bookmark: pgfId-1843023]To select all rows on the page, select the check box at the top of the page.
 
     
 
     [bookmark: pgfId-1973898]You can then click any of the buttons at the bottom of the page (View, Delete, and so on) to perform that action on all of the events on that page.
 
      
      	 [bookmark: pgfId-1973892]To select a single row, select the check box next to the individual row.
 
     
 
     [bookmark: pgfId-1973909]You can then click any of the buttons at the bottom of the page to perform that action on only the events associated with that row.
 
      
      	 [bookmark: pgfId-1973893]To select a single row and view its associated events on the next page of the workflow, click the arrow icon (
 
      [image: ] ). 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1973863]Note You cannot select rows from multiple pages at once. 
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1974099][bookmark: OtherWorkflowPage][bookmark: 31874]Navigating to[bookmark: marker-2400848] Other Pages in the Workflow
 
    [bookmark: pgfId-2996856]License: Any
 
    [bookmark: pgfId-2125066]If the database contains more events than can be displayed on a single workflow page, you can click the links at the bottom of the page to display more events.
 
    [bookmark: pgfId-2725215]When you click one of these links, the time window automatically pauses so that you do not see the same events twice; you can unpause the time window when you are ready. For more information, see Setting Event Time Constraints.
 
    [bookmark: pgfId-2718277]The following table describes how to use the navigation links.
 
    [bookmark: pgfId-2718205]
 
     
      
       
       [bookmark: pgfId-2718170]Table 58-29 [bookmark: 64433]Navigating Pages 
 
       
       
        
        	 
          
          [bookmark: pgfId-2718174]To... 
         
  
        	 
          
          [bookmark: pgfId-2718176]Click... 
         
  
       
 
        
        	[bookmark: pgfId-2718186]view a different page
  
        	[bookmark: pgfId-2718188]the page number, enter the page you wish to view, then press Enter
  
       
 
        
        	[bookmark: pgfId-2718190]view the next page
  
        	[bookmark: pgfId-2718192]>
  
       
 
        
        	[bookmark: pgfId-2718194]view the previous page
  
        	[bookmark: pgfId-2718196]<
  
       
 
        
        	[bookmark: pgfId-2718198]jump to the last page
  
        	[bookmark: pgfId-2718200]>|
  
       
 
        
        	[bookmark: pgfId-2718202]jump to the first page
  
        	[bookmark: pgfId-2718204]|<
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-2490947][bookmark: 17935]Navigating Bet[bookmark: OtherWorkflow]ween[bookmark: marker-2490946] Workflows
 
    [bookmark: pgfId-2996891]License: Any
 
    [bookmark: pgfId-2737173]You can navigate to other workflows using the links in the Jump to... drop-down list on a workflow page. Select the drop-down list to view and select additional workflows.
 
    [bookmark: pgfId-2490949]When you select a new workflow, properties shared by the rows you select and the constraints you set are used in the new workflow, if they are applicable. If configured constraints or event properties do not map to fields in the new workflow, they are dropped. In addition, compound constraints are not retained when you switch from one workflow to another. In addition, constraints from the captured files workflow only transfer to file and malware event workflows.
 
     
      
    
 
    
 
    [bookmark: pgfId-3140319]Note When you view event counts over a time range, the total number of events may not reflect the number of events for which more detailed data is available. This occurs because the system sometimes prunes older event details to manage disk space usage. To minimize the occurrence of event detail pruning, you can fine-tune event logging to log only those events most important to your deployment. For more information, see Logging Connections in Network Traffic.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3140320]Note that unless you have either paused the time window or have configured a static time window, the time window changes when you change workflows. For more information, see Setting Event Time Constraints.
 
    [bookmark: pgfId-2490958]The Jump to drop-down list provides quick access to workflows for the following tables:
 
     
     	 [bookmark: pgfId-3198511]connection events
 
     	 [bookmark: pgfId-3198512]security intelligence events
 
     	 [bookmark: pgfId-3198513]intrusion events
 
     	 [bookmark: pgfId-3198514]malware events
 
     	 [bookmark: pgfId-3198515]file events
 
     	 [bookmark: pgfId-3198516]hosts
 
     	 [bookmark: pgfId-3198517]indications of compromise
 
     	 [bookmark: pgfId-3198518]applications
 
     	 [bookmark: pgfId-3198519]application details
 
     	 [bookmark: pgfId-3198520]servers
 
     	 [bookmark: pgfId-3198521]host attributes
 
     	 [bookmark: pgfId-3198522]discovery events 
 
     	 [bookmark: pgfId-3198523]users
 
     	 [bookmark: pgfId-3198524]vulnerabilities
 
     	 [bookmark: pgfId-3198525]third-party vulnerabilities
 
     	 [bookmark: pgfId-3198526]correlation events
 
     	 [bookmark: pgfId-3198497]white list events
 
    
 
    [bookmark: pgfId-2490982]This feature enhances your ability to investigate suspicious activity. For example, if you are viewing connection data and notice that an internal host is transmitting an abnormally large amount of data to an external site, you can select the responder IP address and the port as constraints and then jump to the Applications workflow. The applications workflow will use the responder IP address and port as IP Address and Port constraints and display additional information about the application, such as what kind of application it is. You can also click Hosts at the top of the page to view the host profile for the remote host.
 
    [bookmark: pgfId-2490983]After finding more information about the application, you can select Correlation Events to return to the connection data workflow, remove the Responder IP from the constraints, add the Initiator IP to constraints, and select Application Details to see what client the user on the initiating host used when transferring data to the remote host. Note that the Port constraint is not transferred to the Application Details page. While keeping the local host as a constraint, you can also use other navigation buttons to find additional information:
 
     
     	 [bookmark: pgfId-2490984]To discover if any policies have been violated by the local host, keep the IP address as a constraint and select  Correlation Events from the  Jump to drop-down list. 
 
     	 [bookmark: pgfId-2490985]To find out if an intrusion rule triggered against the host, indicating a compromise, select  Intrusion Events from the  Jump to drop-down list.
 
     	 [bookmark: pgfId-2490989]To view the host profile for the local host and determine if the host is susceptible to any vulnerabilities that may have been exploited, select  Hosts from the  Jump to drop-down list.
 
    
 
   
 
    
     [bookmark: pgfId-1822586][bookmark: 79403]Using Bookmarks[bookmark: marker-2400850]
 
    [bookmark: pgfId-2996929]License: Any
 
    [bookmark: pgfId-1822588]Create a bookmark if you want to return quickly to a specific location and time in an event analysis. Bookmarks retain information about:
 
     
     	 [bookmark: pgfId-1822589]the workflow you are using
 
     	 [bookmark: pgfId-1822590]the part of the workflow you are viewing
 
     	 [bookmark: pgfId-1822591]the page number within the workflow
 
     	 [bookmark: pgfId-2115392]any search constraints
 
     	 [bookmark: pgfId-2125229]any disabled columns
 
     	 [bookmark: pgfId-1822592]the time range you are using
 
    
 
    [bookmark: pgfId-1822593]The bookmarks you create are available to all user accounts with bookmark access. This means that if you uncover a set of events that require more in-depth analysis, you can easily create a bookmark and turn over the investigation to another user with the appropriate privileges.
 
     
      
    
 
    
 
    [bookmark: pgfId-1842579]Note If the events that appear in a bookmark are deleted (either directly by a user or by automatic database cleanup), the bookmark no longer displays the original set of events.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1842423]See these sections for more information about using bookmarks:
 
     
     	 [bookmark: pgfId-1842424]Creating Bookmarks describes how to create a new bookmark.
 
     	 [bookmark: pgfId-1842507]Viewing Bookmarks describes how to view and use existing bookmarks.
 
     	 [bookmark: pgfId-1842527]Deleting Bookmarks describes how to delete bookmarks.
 
    
 
   
 
    
     [bookmark: pgfId-1822595][bookmark: 91059]Creating Bo[bookmark: BookmarkPage]okmarks
 
    [bookmark: pgfId-2996972]License: Any
 
    [bookmark: pgfId-1842434]Use the following procedure to create a new bookmark.
 
    [bookmark: pgfId-1842385]To create a bookmark:
 
    [bookmark: pgfId-2656141]Access: Admin/Maint/Any Security Analyst
 
    
 
    [bookmark: pgfId-1822596]Step 1 During an event analysis, with the events of interest displayed, click Bookmark This Page.
 
    [bookmark: pgfId-1822597]The Create a Bookmark page appears.
 
    [bookmark: pgfId-1822598]Step 2 In the Bookmark Name field, type a name (up to 80 alphanumeric characters and spaces) for the bookmark, then click Save Bookmark.
 
    [bookmark: pgfId-1822599]The bookmark is saved and the event page you bookmarked appears again.
 
    [bookmark: pgfId-3252658]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1842427][bookmark: 45232]Viewing Bo[bookmark: ViewBookmarks]okmarks
 
    [bookmark: pgfId-2997015]License: Any
 
    [bookmark: pgfId-1842437]Use the following procedure to view and use existing bookmarks. 
 
    [bookmark: pgfId-1842425]To view a bookmark:
 
    [bookmark: pgfId-3053906]Access: Admin/Maint/Any Security Analyst
 
    
 
    [bookmark: pgfId-3053907]Step 1 From any event view, click View Bookmarks.
 
    [bookmark: pgfId-3053911]The Bookmarks page appears.
 
    [bookmark: pgfId-2414186]Step 2 Next to the bookmark you want to use, click View.
 
    [bookmark: pgfId-1822604]The page you bookmarked appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-1822605]Note If the events that originally appeared in a bookmark are deleted (either directly by a user or by automatic database cleanup), the bookmark no longer displays the original set of events.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3252646]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1822606][bookmark: 30150]Deleting Bookmarks
 
    [bookmark: pgfId-2997058]License: Any
 
    [bookmark: pgfId-1842468]Use the following procedure to delete bookmarks. Note that deleting a bookmark does not affect the events retrieved by that bookmark.
 
    [bookmark: pgfId-1842438]To delete a bookmark:
 
    [bookmark: pgfId-2656156]Access: Admin/Maint/Any Security Analyst
 
    
 
    [bookmark: pgfId-1822607]Step 1 From any event view, click View Bookmarks.
 
    [bookmark: pgfId-1822608]The Bookmarks page appears.
 
    [bookmark: pgfId-1822609]Step 2 Click Delete next to the bookmark you want to remove.
 
    [bookmark: pgfId-1822610]The bookmark is deleted.
 
    [bookmark: pgfId-3252627]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1855196][bookmark: 25830]Using Custo[bookmark: marker-1855195]m Workflows
 
    [bookmark: pgfId-2997100]License: Any
 
    [bookmark: pgfId-2350826]If the predefined and Cisco-provided custom workflows do not meet your needs, you can create custom workflows.
 
    [bookmark: pgfId-2647013]For more information, see:
 
     
     	 [bookmark: pgfId-2350830]Creating Custom Workflows for a procedure to create custom workflows
 
     	 [bookmark: pgfId-2491194]Creating Custom Connection Data Workflows for a procedure to create a custom workflow based on connection data
 
     	 [bookmark: pgfId-2350838]Viewing Custom Workflows for procedures for viewing custom workflows based on event and custom tables
 
     	 [bookmark: pgfId-2350842]Editing Custom Workflows for a procedure for editing custom workflows
 
     	 [bookmark: pgfId-2350846]Deleting Custom Workflows for a procedure for deleting custom workflows
 
    
 
     
      [bookmark: pgfId-2656017][bookmark: 57528]Creating Custom Workflows
 
     [bookmark: pgfId-2997123]License: Any
 
     [bookmark: pgfId-1838045]If the predefined and Cisco-provided custom workflows do not meet your needs, you can create custom workflows.
 
      
       
     
 
     
 
     [bookmark: pgfId-2731925]Tip Instead of creating a new custom workflow, you can export a custom workflow from another appliance and then import it onto your appliance. You can then edit the imported workflow to suit your needs. For more information, see Importing and Exporting Configurations.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2732808]When you create a custom workflow, you:
 
      
      	 [bookmark: pgfId-2732809]select a table to be the source of the workflow
 
      	 [bookmark: pgfId-2732810]provide a workflow name
 
      	 [bookmark: pgfId-1838301]add drill-down pages and table view pages to the workflow
 
     
 
     [bookmark: pgfId-1838308]For each drill-down page in the workflow, you can:
 
      
      	 [bookmark: pgfId-1976052]provide a name that appears at the top of the page in the web interface
 
      	 [bookmark: pgfId-1976065]include up to five columns per page
 
      	 [bookmark: pgfId-1976090]specify a default sort order, ascending or descending
 
     
 
     [bookmark: pgfId-2005412]You can add table view pages in any position in the sequence of workflow pages. They do not have any editable properties, such as a page name, sort order, or user-definable column positions. 
 
     [bookmark: pgfId-2720617]The final page of a custom workflow depends on the table on which you base the workflow, as described in the following table. These final pages are added by default when you create the workflow.
 
     [bookmark: pgfId-2720299]
 
      
       
        
        [bookmark: pgfId-3051210]Table 58-30 [bookmark: 84612]Custom Workflow Final Pages 
 
        
        
         
         	 
           
           [bookmark: pgfId-3051214]Workflows based on... 
          
  
         	 
           
           [bookmark: pgfId-3051216]Have this final page... 
          
  
        
 
         
         	[bookmark: pgfId-3051218]discovery events
  
         	[bookmark: pgfId-3051220]hosts
  
        
 
         
         	[bookmark: pgfId-3051222]vulnerabilities
  
         	[bookmark: pgfId-3051224]vulnerability detail
  
        
 
         
         	[bookmark: pgfId-3051226]third-party vulnerabilities
  
         	[bookmark: pgfId-3051228]hosts
  
        
 
         
         	[bookmark: pgfId-3051233]users
  
         	[bookmark: pgfId-3051238]users
  
        
 
         
         	[bookmark: pgfId-3195340]indications of compromise
  
         	[bookmark: pgfId-3195342]hosts
  
        
 
         
         	[bookmark: pgfId-3051240]intrusion events
  
         	[bookmark: pgfId-3051242]packets
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2720531]The appliance does not add a final page to custom workflows based on other kinds of events (for example, audit log or malware events).
 
      
       
     
 
     
 
     [bookmark: pgfId-2491220]Note The procedure for creating a custom workflow based on connection data is slightly different. For more information, see the next section, Creating Custom Connection Data Workflows.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1917887]To create a custom workflow:
 
     [bookmark: pgfId-2637073]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1827891]Step 1 Select Analysis > Custom > Custom Workflows.
 
     [bookmark: pgfId-1678156]The Custom Workflows page appears.
 
     [bookmark: pgfId-2005908]Step 2 Click Create Custom Workflow.
 
     [bookmark: pgfId-2747267]The Edit Custom Workflow page appears.
 
     [bookmark: pgfId-2747250]Step 3 Type a name for the workflow in the Name field.
 
     [bookmark: pgfId-1678158]You can use up to 60 alphanumeric characters and spaces in the name.
 
     [bookmark: pgfId-1678159]Step 4 Optionally, type a description for the workflow in the Description field.
 
     [bookmark: pgfId-1678160]You can use up to 80 alphanumeric characters and spaces.
 
     [bookmark: pgfId-2085341]Step 5 [bookmark: 26968]Select the table you want to include from the Table drop-down list.
 
     [bookmark: pgfId-2085634]Step 6 [bookmark: 13724]Optionally, click Add Page to add one or more drill-down pages to the workflow.
 
     [bookmark: pgfId-2085351]A drill-down page section appears.
 
     [bookmark: pgfId-2085626]Begin by typing a name for the page in the Page Name field, using up to 80 alphanumeric characters, but no spaces.
 
     [bookmark: pgfId-2085791]Under Column 1, select a sort priority and a table column. This column will appear in the leftmost column of the page. For example, to create a page showing the destination ports that are targeted, and to sort the page by count, select 2 from the Sort Priority drop-down list and DST Port/ICMP Code from the Field drop-down list.
 
     [bookmark: pgfId-2085795]Continue selecting fields to include and setting their sort priority until all the fields to appear on the page have been specified. You can specify up to five fields per page.
 
      
       
     
 
     
 
     [bookmark: pgfId-2491304]Note If you selected Vulnerabilities as the Table Type in step 5, then add IP Address as a table column, the IP Address column does not appear when you are viewing vulnerabilities using your custom workflow, unless you use the search feature to constrain the workflow to view a specific IP address or block of addresses. For more information on searching for vulnerabilities, see Searching for Vulnerabilities.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2085815]Step 7 Optionally, click Add Table View to add a table view page to the workflow.
 
      
       
     
 
     
 
     [bookmark: pgfId-2385995]Note You must add at least one drill-down page or a table view of events to a custom workflow.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1678174]Step 8 Click Save.
 
     [bookmark: pgfId-1678175]The new workflow is saved and added to the list of custom workflows.
 
     [bookmark: pgfId-3252599]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2491314][bookmark: 64220]Creating Custom[bookmark: marker-2491313] Connection Data Workflows
 
     [bookmark: pgfId-2997153]License: FireSIGHT
 
     [bookmark: pgfId-2568922]Custom workflows based on connection data are like other custom workflows, except you can include connection data graph pages as well as drill-down pages and table view pages. You can include as many of each type of page in the workflow as you want, in any order. Each connection data graph page contains a single graph, which can be a line graph, bar graph, or pie chart. On line and bar graphs, you may include more than one dataset. For more information on connection data, including connection summaries, connection graphs, and datasets, see Understanding Connection and Security Intelligence Data.
 
      
       
     
 
     
 
     [bookmark: pgfId-2732066]Tip Instead of creating a new custom workflow, you can export a custom workflow from another appliance and then import it onto your appliance. You can then edit the imported workflow to suit your needs. For more information, see Importing and Exporting Configurations.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2491320]To create a custom workflow based on connection data:
 
     [bookmark: pgfId-2681325]Access: Admin
 
     
 
     [bookmark: pgfId-2491321]Step 1 Select Analysis > Custom > Custom Workflow.
 
     [bookmark: pgfId-2749217]Step 2 Click Create Custom Workflow.
 
     [bookmark: pgfId-2749218]The Edit Custom Workflow page appears.
 
     [bookmark: pgfId-2491331]Step 3 Type a name for the workflow in the Name field.
 
     [bookmark: pgfId-2491332]You can use up to 60 alphanumeric characters and spaces.
 
     [bookmark: pgfId-2491333]Step 4 Optionally, type a description for the workflow in the Description field.
 
     [bookmark: pgfId-2491334]You can use up to 80 alphanumeric characters and spaces.
 
     [bookmark: pgfId-2491338]Step 5 From the Table drop-down list, select Connection Events.
 
     [bookmark: pgfId-2491344]Step 6 Optionally, add one or more drill-down pages to the workflow:
 
      
       
       	 [bookmark: pgfId-2569046]To add a drill-down page that contains data on individual connections, click  Add Page .
 
       	 [bookmark: pgfId-2569082]To add a drill-down page that contains connection summary data, click  Add Summary Page .
 
      
 
     
 
     [bookmark: pgfId-2491345]In either case, a drill-down page section appears.
 
     [bookmark: pgfId-2491350]Begin by typing a name for the page in the Page Name field using up to 80 alphanumeric characters, but no spaces.
 
     [bookmark: pgfId-2491351]Under Column 1, select a sort priority and a table column. This column will appear in the leftmost column of the page.
 
     [bookmark: pgfId-2491352]Continue selecting fields to include and setting their sort priority until all the fields to appear on the page have been specified. You can specify up to five fields per page.
 
     [bookmark: pgfId-2491356]For example, to create a page showing the amount of traffic transmitted over your monitored network and to sort the page by the responders that transmitted the most traffic, select 1 from the Sort Priority drop-down list and Responder Bytes from the Field drop-down list.
 
     [bookmark: pgfId-2491357]Step 7 Optionally, click Add Graph to add one or more graph pages to the workflow.
 
     [bookmark: pgfId-2491358]A graph section appears.
 
     [bookmark: pgfId-2491363]Begin by typing a name for the page in the Graph Name field using up to 80 alphanumeric characters, but no spaces.
 
     [bookmark: pgfId-2491364]Then, select the type of graph you want to include on the page: line graph, bar graph, or pie chart. 
 
     [bookmark: pgfId-2491365]Then, specify what kind of data you want to graph by selecting the x- and y-axes of the graph. On a pie chart, the x-axis represents the independent variable and the y-axis represents the dependent variable.
 
     [bookmark: pgfId-2491366]Finally, select the datasets you want to include on the graph. Note that pie charts can only include one data set.
 
     [bookmark: pgfId-2491367]Step 8 Optionally, add a table view of connection data by clicking Add Table View.
 
     [bookmark: pgfId-2491368]Step 9 Click Save.
 
     [bookmark: pgfId-2491369]The new workflow is saved and added to the list of custom workflows.
 
     [bookmark: pgfId-3252583]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2004877][bookmark: 73342]Viewing Custom[bookmark: marker-2400855] Workflows
 
     [bookmark: pgfId-2997204]License: Any
 
     [bookmark: pgfId-2491455]The method you use to view a workflow depends on whether the workflow is based on one of the predefined event tables or on a custom table. 
 
     [bookmark: pgfId-2491456]If your custom workflow is based on a predefined event table, access it in the same way that you would access a workflow that ships with the appliance. For example, to access a custom workflow based on the Hosts table, select Analysis Hosts. If, on the other hand, your custom workflow is based on a custom table, you must access it from the Custom Tables page.
 
      
       
     
 
     
 
     [bookmark: pgfId-2677783]Tip You can set a custom workflow as the default workflow for any event type; see Configuring Event View Settings.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2491463]For more information, see:
 
      
      	 [bookmark: pgfId-2491467]Viewing Custom Workflows for Predefined Tables
 
      	 [bookmark: pgfId-2491471]Viewing Custom Workflows for Custom Tables
 
     
 
    
 
     
      [bookmark: pgfId-2491490][bookmark: 87163]Viewing Custom Workflows for Predefined Tables
 
     [bookmark: pgfId-2997235]License: Any
 
     [bookmark: pgfId-1893101]Use the following procedure to view a custom workflow that is not based on a custom table. Keep in mind that workflow access depends on your platform and user role, as described in Selecting Workflows.
 
     [bookmark: pgfId-1843670]To view a custom workflow based on a predefined table:
 
     [bookmark: pgfId-2677850]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2677866]Step 1 Select the appropriate menu path and option for the table on which you based your custom workflow, as described in the Features Using Workflows table.
 
     [bookmark: pgfId-2677907]The first page of the default workflow for that table appears. To use a different workflow, including a custom workflow, click (switch workflow) beside the current workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear and the workflow can be constrained by time, you may need to adjust the time range; see Setting Event Time Constraints.
 
     [bookmark: pgfId-3252568]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2491506][bookmark: 57571]Viewing Custom Workflows for Custom Tables
 
     [bookmark: pgfId-2997262]License: FireSIGHT
 
     [bookmark: pgfId-2491507]Use the following procedure to view a custom workflow that is based on a custom table. 
 
     [bookmark: pgfId-2491508]To view a custom workflow based on a custom table:
 
     [bookmark: pgfId-2681335]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-2491509]Step 1 Select Analysis > Custom > Custom Tables.
 
     [bookmark: pgfId-2491510]The Custom Tables page appears, listing the available custom tables.
 
     [bookmark: pgfId-2491511]Step 2 Click the view icon next to the custom table you want to view, or click the name of the custom table.
 
     [bookmark: pgfId-2677957]The first page of the default workflow for that table appears. To use a different workflow, including a custom workflow, click (switch workflow) beside the current workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear and the workflow can be constrained by time, you may need to adjust the time range; see Setting Event Time Constraints.
 
     [bookmark: pgfId-3252552]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1907493][bookmark: 41473]Editing Custo[bookmark: marker-1907492]m Workflows
 
     [bookmark: pgfId-2997291]License: Any
 
     [bookmark: pgfId-1678217]If your event evaluation process changes, you can edit custom workflows to meet your new needs. Note that you cannot edit any of the predefined workflows.
 
     [bookmark: pgfId-1678219]To edit a custom workflow:
 
     [bookmark: pgfId-2681340]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1678220]Step 1 Select Analysis > Custom > Custom Workflows.
 
     [bookmark: pgfId-3081113]The Custom Workflows page appears, listing the existing custom workflows.
 ) next to the name of the workflow that you want to edit. 
     
 
     [bookmark: pgfId-3081118]The Edit Workflow page appears.
 
     [bookmark: pgfId-1678224]Step 3 Make any changes that you want to the workflow and click Save.
 
     [bookmark: pgfId-1678225]The changes you made to the workflow are saved.
 
     [bookmark: pgfId-3252536]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1678228][bookmark: 83843]Deleting Cust[bookmark: marker-1678227]om Workflows
 
     [bookmark: pgfId-2997318]License: Any
 
     [bookmark: pgfId-1981015]The following procedure explains how to delete a custom workflow that you no longer need.
 
     [bookmark: pgfId-1678231]To delete a custom workflow:
 
     [bookmark: pgfId-2681345]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1807592]Step 1 Select Analysis > Custom > Custom Workflows.
 
     [bookmark: pgfId-1678233]The Custom Workflows page appears, listing the available custom workflows.
 ) next to the name of the workflow that you want to delete. 
     
 
     [bookmark: pgfId-1678235]The workflow is deleted.
 
     [bookmark: pgfId-3252439]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1778277]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1055899][bookmark: 14825]Using C[bookmark: marker-1731827]ustom[bookmark: marker-1662142] Tables 
      
      
 
     
 
 
    [bookmark: pgfId-1599299]As the FireSIGHT System collects information about your network, the Defense Center stores it in a series of database tables. When you use a workflow to view the resulting information, the Defense Center pulls the data from one of these tables. For example, the columns on each page of the Network Applications by Count workflow are taken from the fields in the Applications table. 
 
    [bookmark: pgfId-1651489]If you determine that your analysis of the activity on your network would be enhanced by combining fields from different tables, you can create a custom table. For example, you could combine the host criticality information from the predefined Host Attributes table with the fields from the predefined Connection Data table and then examine connection data in a new context.
 
    [bookmark: pgfId-1674781]Note that you can create custom workflows for either predefined or custom tables. For more information on creating custom workflows, see Creating Custom Workflows.
 
    [bookmark: pgfId-1469326]The following sections describe how to create and use your own custom tables:
 
     
     	 [bookmark: pgfId-1599312]Understanding Custom Tables
 
     	 [bookmark: pgfId-1639116]Creating a Custom Table
 
     	 [bookmark: pgfId-1639120]Modifying a Custom Table
 
     	 [bookmark: pgfId-1639124]Deleting a Custom Table
 
     	 [bookmark: pgfId-1639128]Viewing a Workflow Based on a Custom Table
 
     	 [bookmark: pgfId-1639132]Searching Custom Tables
 
    
 
   
 
    
     [bookmark: pgfId-1739569][bookmark: 51321]Understanding Cust[bookmark: marker-1739567]om Tables
 
    [bookmark: pgfId-1747130]License: FireSIGHT
 
    [bookmark: pgfId-1601341]Custom tables contain fields from two or more predefined tables. The FireSIGHT System is delivered with a number of system-defined custom tables, but you can create additional custom tables that contain only information that matches your specific needs. 
 
     
      
       
       [bookmark: pgfId-1695598]Table 59-1 [bookmark: 70815]System-Defined Custom Tables 
 
       
       
        
        	 
          
          [bookmark: pgfId-1695602]Table 
         
  
        	 
          
          [bookmark: pgfId-1695604]Description 
         
  
       
 
        
        	[bookmark: pgfId-1749992]Hosts with Servers
  
        	[bookmark: pgfId-1749994]Includes fields from the Hosts and Servers tables, providing you with information about the detected applications running on your network, as well as basic operating system information about the hosts running those applications.
  
       
 
        
        	[bookmark: pgfId-1695609]Intrusion Events with Destination Criticality
  
        	[bookmark: pgfId-1695611]Includes fields from the Intrusion Events table and the Hosts table, providing you with information on the intrusion events, as well as the host criticality of the destination host involved in each intrusion event.
 [bookmark: pgfId-1695618]Tip Use this table to search for intrusion events involving destination hosts with high host criticality.  
       
 
        
        	[bookmark: pgfId-1695620]Intrusion Events with Source Criticality
  
        	[bookmark: pgfId-1739639]Includes fields from the Intrusion Events table and the Hosts table, providing you with information on the intrusion events and the host criticality of the source host involved in each intrusion event.
 [bookmark: pgfId-1695633]Tip Use this table to search for intrusion events involving source hosts with high host criticality.  
       
 
       
     
 
    
 
     
      [bookmark: pgfId-1695648][bookmark: 52460]Understanding Possible[bookmark: marker-1695647] Table Combinations
 
     [bookmark: pgfId-1747153]License: FireSIGHT + Protection
 
      
       
        
        [bookmark: pgfId-1601424]Table 59-2 [bookmark: 98138]Custom Table Combinations 
 
        
        
         
         	 
           
           [bookmark: pgfId-1601428]You can combine fields from... 
          
  
         	 
           
           [bookmark: pgfId-1601430]With fields from... 
          
  
        
 
         
         	[bookmark: pgfId-1749370]Applications
  
         	 
           
           	 [bookmark: pgfId-1749426]Correlation Events
 
           	 [bookmark: pgfId-1757006]Intrusion Events
 
           	 [bookmark: pgfId-1757089]Connection Summary Data
 
           	 [bookmark: pgfId-1749427]Host Attributes
 
           	 [bookmark: pgfId-1757031]Application Details
 
           	 [bookmark: pgfId-1757057]Discovery Events
 
           	 [bookmark: pgfId-1749428]Connection Events
 
           	 [bookmark: pgfId-1749429]Hosts
 
           	 [bookmark: pgfId-1750066]Servers
 
           	 [bookmark: pgfId-1757127]White List Events
 
          
  
        
 
         
         	[bookmark: pgfId-1680314]Correlation Events
  
         	 
           
           	 [bookmark: pgfId-1680316]Applications
 
           	 [bookmark: pgfId-1756987]Host Attributes
 
           	 [bookmark: pgfId-1680320]Hosts
 
          
  
        
 
         
         	[bookmark: pgfId-1601437]Intrusion Events
  
         	 
           
           	 [bookmark: pgfId-1601439]Applications
 
           	 [bookmark: pgfId-1757159]Host Attributes
 
           	 [bookmark: pgfId-1601440]Hosts
 
           	 [bookmark: pgfId-1601441]Servers
 
          
  
        
 
         
         	[bookmark: pgfId-1680247]Connection Summary Data
  
         	 
           
           	 [bookmark: pgfId-1680335]Applications
 
           	 [bookmark: pgfId-1757194]Host Attributes
 
           	 [bookmark: pgfId-1680339]Hosts
 
           	 [bookmark: pgfId-1680343]Servers
 
          
  
        
 
         
         	[bookmark: pgfId-1770602]Indications of [bookmark: marker-1771622]Compromise
  
         	 
           
           	 [bookmark: pgfId-1770813]Applications
 
           	 [bookmark: pgfId-1771277]Application Details
 
           	 [bookmark: pgfId-1771361]Captured Files
 
           	 [bookmark: pgfId-1771304]Connection Events
 
           	 [bookmark: pgfId-1770816]Connection Summary Data
 
           	 [bookmark: pgfId-1771336]Correlation Events
 
           	 [bookmark: pgfId-1771390]Discovery Events
 
           	 [bookmark: pgfId-1770817]Host Attributes
 
           	 [bookmark: pgfId-1770883]Hosts
 
           	 [bookmark: pgfId-1771248]Intrusion Events
 
           	 [bookmark: pgfId-1771421]Security Intelligence Events
 
           	 [bookmark: pgfId-1770821]Servers
 
           	 [bookmark: pgfId-1770822]White List Events
 
          
  
        
 
         
         	[bookmark: pgfId-1601443]Host Attributes
  
         	 
           
           	 [bookmark: pgfId-1680359]Applications
 
           	 [bookmark: pgfId-1757213]Correlation Events
 
           	 [bookmark: pgfId-1668869]Intrusion Events
 
           	 [bookmark: pgfId-1757249]Connection Summary Data
 
           	 [bookmark: pgfId-1757250]Application Details
 
           	 [bookmark: pgfId-1757251]Discovery Events
 
           	 [bookmark: pgfId-1757264]Connection Events
 
           	 [bookmark: pgfId-1601450]Hosts
 
           	 [bookmark: pgfId-1750077]Servers
 
           	 [bookmark: pgfId-1648670]White List Events
 
          
  
        
 
         
         	[bookmark: pgfId-1601453]Application Details
  
         	 
           
           	 [bookmark: pgfId-1601455]Applications
 
           	 [bookmark: pgfId-1757354]Host Attributes
 
           	 [bookmark: pgfId-1601456]Hosts
 
          
  
        
 
         
         	[bookmark: pgfId-1601458]Discovery Events
  
         	 
           
           	 [bookmark: pgfId-1601460]Applications
 
           	 [bookmark: pgfId-1757397]Host Attributes
 
           	 [bookmark: pgfId-1601461]Hosts
 
          
  
        
 
         
         	[bookmark: pgfId-1601463]Connection Events
  
         	 
           
           	 [bookmark: pgfId-1601465]Applications
 
           	 [bookmark: pgfId-1757433]Host Attributes
 
           	 [bookmark: pgfId-1601466]Hosts
 
           	 [bookmark: pgfId-1601467]Servers
 
          
  
        
 
         
         	[bookmark: pgfId-1770181]Security Intelligence Events[bookmark: marker-1771673]
  
         	 
           
           	 [bookmark: pgfId-1770183]Applications
 
           	 [bookmark: pgfId-1770237]Host Attributes
 
           	 [bookmark: pgfId-1770258]Hosts
 
           	 [bookmark: pgfId-1770277]Servers
 
          
  
        
 
         
         	[bookmark: pgfId-1601469]Hosts
  
         	 
           
           	 [bookmark: pgfId-1680386]Applications
 
           	 [bookmark: pgfId-1757485]Correlation Events
 
           	 [bookmark: pgfId-1757509]Intrusion Events
 
           	 [bookmark: pgfId-1757531]Connection Summary Data
 
           	 [bookmark: pgfId-1757568]Host Attributes
 
           	 [bookmark: pgfId-1757589]Application Details
 
           	 [bookmark: pgfId-1757627]Discovery Events
 
           	 [bookmark: pgfId-1757657]Connection Events
 
           	 [bookmark: pgfId-1757680]Servers
 
           	 [bookmark: pgfId-1757705]White List Events
 
          
  
        
 
         
         	[bookmark: pgfId-1750005]Servers
  
         	 
           
           	 [bookmark: pgfId-1750007]Applications
 
           	 [bookmark: pgfId-1757764]Intrusion Events
 
           	 [bookmark: pgfId-1757789]Connection Summary Data
 
           	 [bookmark: pgfId-1757825]Host Attributes
 
           	 [bookmark: pgfId-1757854]Connection Events
 
           	 [bookmark: pgfId-1757884]Hosts
 
          
  
        
 
         
         	[bookmark: pgfId-1646936]White List Events
  
         	 
           
           	 [bookmark: pgfId-1646942]Applications
 
           	 [bookmark: pgfId-1757904]Host Attributes
 
           	 [bookmark: pgfId-1646950]Hosts
 
          
  
        
 
        
      
 
     
 
     [bookmark: pgfId-1647158]Sometimes a field in one table maps to more than one field in another table. For example, the predefined Intrusion Events with Destination Criticality custom table combines fields from the Intrusion Events table and the Hosts table. Each event in the Intrusion Events table has two IP addresses associated with it—a source IP address and a destination IP address. However, the “events” in the Hosts table each represent a single host IP address (hosts may have multiple IP addresses). Therefore, when you create a custom table based on the Intrusion Events table and the Hosts table, you must choose whether the data you display from the Hosts table applies to the host source IP address or the host destination IP address in the Intrusion Events table.
 
     [bookmark: pgfId-1647183]When you create a new custom table, a default workflow that displays all the columns in the table is automatically created. Also, just as with predefined tables, you can search custom tables for data that you want to use in your network analysis. You can also generate reports based on custom tables, as you can with predefined tables.
 
     [bookmark: pgfId-1601488]For more information on creating custom tables, see:
 
      
      	 [bookmark: pgfId-1601492]Creating a Custom Table
 
      	 [bookmark: pgfId-1601496]Modifying a Custom Table
 
      	 [bookmark: pgfId-1601500]Deleting a Custom Table
 
      	 [bookmark: pgfId-1601504]Viewing a Workflow Based on a Custom Table
 
      	 [bookmark: pgfId-1601508]Searching Custom Tables
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1601528][bookmark: 48433]Creating a Cust[bookmark: marker-1601526]om Table
 
    [bookmark: pgfId-1747101]License: FireSIGHT
 
    [bookmark: pgfId-1701180]If you determine that your analysis of the activity on your network would be enhanced by combining fields from different tables, you can create a custom table. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1701222]Tip Instead of creating a new custom table, you can export a custom table from another Defense Center, then import it onto your Defense Center. You can then edit the imported custom table to suit your needs. For more information, see Importing and Exporting Configurations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1675131]To create a custom table, decide which predefined tables delivered with the FireSIGHT System contain the fields you want to include in your custom table. You can then choose which fields you want to include and, if necessary, configure field mappings for any common fields.
 
     
      
    
 
    
 
    [bookmark: pgfId-1766761]Tip Data involving the Hosts table allows you to view data associated with all IP addresses from one host, rather than one specific IP address.
 
     
     
 
    
 
    
 
     
     [image: ] 
    
 
    [bookmark: pgfId-1793451]If you view the table view of events for this custom table, it displays correlation events, one per row. The following information is included:
 
     
     	 [bookmark: pgfId-1601545]the date and time the event was generated
 
     	 [bookmark: pgfId-1601546]the name of the correlation policy that was violated
 
     	 [bookmark: pgfId-1601547]the name of the rule that triggered the violation
 
     	 [bookmark: pgfId-1601548]the IP address associated with the source, or initiating, host involved in the correlation event
 
     	 [bookmark: pgfId-1601549]the source host’s NetBIOS name
 
     	 [bookmark: pgfId-1601550]the operating system and version the source host is running
 
     	 [bookmark: pgfId-1601551]the source host criticality
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1601552]Tip You could create a similar custom table that displays the same information for destination, or responding, hosts.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1601553]To build the custom table in the previous example:
 
    [bookmark: pgfId-1695112]Access: Admin
 
    
 
    [bookmark: pgfId-1601554]Step 1 Select Analysis > Custom > Custom Tables.
 
    [bookmark: pgfId-1601555]The Custom Tables page appears.
 
    [bookmark: pgfId-1601564]Step 2 Click Create Custom Table.
 
    [bookmark: pgfId-1601565]The Create Custom Table page appears.
 
    [bookmark: pgfId-1647928]Step 3 In the Name field, type a name for the custom table, such as Correlation Events with Host Information (Src IP).
 
    [bookmark: pgfId-1647929]Step 4 From the Tables drop-down list, select Correlation Events.
 
    [bookmark: pgfId-1647930]The fields in the Correlation Events table appear in the Fields list.
 
    [bookmark: pgfId-1647932]Step 5 [bookmark: 61312]Under Fields, select Time and click Add to add the date and time when a correlation event was generated.
 
    [bookmark: pgfId-1647936]Step 6 Repeat step 5 to add the Policy and Rule fields.
 
     
      
    
 
    
 
    [bookmark: pgfId-1648043]Tip You can use Ctrl or Shift while clicking to select multiple fields. You can also click and drag to select multiple adjacent values. However, if you want to specify the order the fields appear in the table view of events associated with the table, add the fields one at a time.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1648044]Step 7 From the Tables drop-down list, select Hosts.
 
    [bookmark: pgfId-1648045]The fields in the Hosts table appear in the Fields list. For more information on these fields, see Understanding the Hosts Table.
 
    [bookmark: pgfId-1647944]Step 8 [bookmark: 42511]Add the IP Address, NetBIOS Name, OS Name, OS Version, and Host Criticality fields to the custom table.
 
    [bookmark: pgfId-1647945]Step 9 Under Common Fields, next to Correlation Events, select Source IP.
 
    [bookmark: pgfId-1647946]Your custom table is configured to display the host information you chose in step 8 for the source, or initiating, hosts involved in correlation events.
 
     
      
    
 
    
 
    [bookmark: pgfId-1647950]Tip You could create a custom table that displays detailed host information for the destination, or responding, hosts involved in a correlation event by following this procedure but selecting Destination IP instead of Source IP.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1647951]Step 10 Click Save.
 
    [bookmark: pgfId-1647952]The custom table is saved.
 
    [bookmark: pgfId-1782888]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1601621][bookmark: 82311]Modifying a Custo[bookmark: marker-1601620]m Table
 
    [bookmark: pgfId-1739434]License: FireSIGHT
 
    [bookmark: pgfId-1675178]You can add or delete fields in a custom table as your needs change.
 
    [bookmark: pgfId-1647986]To modify a custom table:
 
    [bookmark: pgfId-1695117]Access: Any/Admin 
 
    
 
    [bookmark: pgfId-1747301]Step 1 Select Analysis > Custom > Custom Tables.
 
    [bookmark: pgfId-1601624]The Custom Tables page appears.
 ) next to the table you want to edit. 
    
 
    [bookmark: pgfId-1601629]The Edit Custom Table page appears. See Creating a Custom Table for information on the various configurations you can change.
 ) next to the fields you want to remove. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1771524]Note If you delete fields currently in use in reports, you will be prompted to confirm that you want to remove the sections using those fields from those reports.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1771525]Step 4 Make other changes as needed and click Save.
 
    [bookmark: pgfId-1601632]Your custom table is updated.
 
    [bookmark: pgfId-1782902]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1601654][bookmark: 77805]Deleting a[bookmark: marker-1662217] Custom Table
 
    [bookmark: pgfId-1739454]License: FireSIGHT
 
    [bookmark: pgfId-1675222]You can delete a custom table that you no longer need. If you delete a custom table, saved searches that use the custom table are also deleted.
 
    [bookmark: pgfId-1695130]To delete a custom table:
 
    [bookmark: pgfId-1695136]Access: Any/Admin 
 
    
 
    [bookmark: pgfId-1747313]Step 1 Select Analysis > Custom > Custom Tables.
 
    [bookmark: pgfId-1601658]The Custom Tables page appears.
 ) next to the custom table you want to delete. 
    
 
    [bookmark: pgfId-1601660]The table is deleted.
 
    [bookmark: pgfId-1782913]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1601684][bookmark: 69352]Viewing a Workflow B[bookmark: marker-1601682]ased on a Custom Table
 
    [bookmark: pgfId-1739474]License: FireSIGHT
 
    [bookmark: pgfId-1601689]When you create a custom table, the system automatically creates a default workflow for it. The first page of this workflow displays a table view of events. If you include intrusion events in your custom table, the second page of the workflow is the packet view. Otherwise, the second page of the workflow is a hosts page. You can also create your own custom workflows based on your custom table.
 
     
      
    
 
    
 
    [bookmark: pgfId-1601690]Tip If you create a custom workflow based on a custom table, you can specify it as the default workflow for that table. For more information, see Configuring Event View Settings.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1601694]You can use the same techniques to view events in your custom table that you use for event views based on predefined tables. See Using Workflow Pages for more information.
 
    [bookmark: pgfId-1601698]To view a workflow based on a custom table: 
 
    [bookmark: pgfId-1695141]Access: Any/Admin 
 
    
 
    [bookmark: pgfId-1747337]Step 1 Select Analysis > Custom > Custom Tables.
 
    [bookmark: pgfId-1601700]The Custom Tables page appears.
 ) next to the custom table on which the workflow you want to see is based. 
    
 
    [bookmark: pgfId-1699259]The first page of the default workflow for the custom table appears. To use a different workflow, click (switch workflow) by the workflow title. For information on how to specify a different default workflow, see Configuring Event View Settings. If no events appear and the workflow can be constrained by time, you may need to adjust the time range; see Setting Event Time Constraints.
 
    [bookmark: pgfId-1782927]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1601730][bookmark: 98979]Searching Cu[bookmark: marker-1601728]stom Tables
 
    [bookmark: pgfId-1748074]License: FireSIGHT
 
    [bookmark: pgfId-1749732]You can create and save searches for a custom table. You may want to create searches customized for your network environment, then save them to reuse later. Note that if you delete a custom table, all searches you have saved for that custom table are also deleted.
 
    [bookmark: pgfId-1772347]The search criteria you can use are the same as the criteria for the predefined tables you used to build your custom table. See the sections listed in the following table for detailed information on the search criteria you can use.
 
     
      
       
       [bookmark: pgfId-1772350]Table 59-3 [bookmark: 72369]Table Search Criteria 
 
       
       
        
        	 
          
          [bookmark: pgfId-1772354]For search criteria for... 
         
  
        	 
          
          [bookmark: pgfId-1772356]See... 
         
  
       
 
        
        	[bookmark: pgfId-1772358]Audit Events
  
        	[bookmark: pgfId-1772363]Searching Audit Records
  
       
 
        
        	[bookmark: pgfId-1772365]Application Details
  
        	[bookmark: pgfId-1772369]Searching for Application Details
  
       
 
        
        	[bookmark: pgfId-1772372]Correlation Events
  
        	[bookmark: pgfId-1772376]Searching for Correlation Events
  
       
 
        
        	[bookmark: pgfId-1772379]Connection Data
  
        	[bookmark: pgfId-1772383]Searching for Connection and Security Intelligence Data
  
       
 
        
        	[bookmark: pgfId-1772386]Hosts
  
        	[bookmark: pgfId-1772391]Searching for Hosts
  
       
 
        
        	[bookmark: pgfId-1772393]Host Attributes
  
        	[bookmark: pgfId-1772398]Searching for Host Attributes
  
       
 
        
        	[bookmark: pgfId-1772400]Hosts with Applications
  
        	[bookmark: pgfId-1772405]Searching for Hosts and Searching for Servers
  
       
 
        
        	[bookmark: pgfId-1772410]Intrusion Events
  
        	[bookmark: pgfId-1772415]Searching for Intrusion Events
  
       
 
        
        	[bookmark: pgfId-1772417]Intrusion Events with Destination Criticality
  
        	[bookmark: pgfId-1772422]Searching for Intrusion Events and Searching for Hosts
  
       
 
        
        	[bookmark: pgfId-1772427]Intrusion Events with Source Criticality
  
        	[bookmark: pgfId-1772432]Searching for Intrusion Events and Searching for Hosts
  
       
 
        
        	[bookmark: pgfId-1772437]Status Events
  
        	[bookmark: pgfId-1772441]Searching for Remediation Status Events
  
       
 
        
        	[bookmark: pgfId-1772444]Discovery Events
  
        	[bookmark: pgfId-1772448]Searching for Discovery Events
  
       
 
        
        	[bookmark: pgfId-1772451]User Events
  
        	[bookmark: pgfId-1772456]Searching for User Activity
  
       
 
        
        	[bookmark: pgfId-1772458]Rule Update Import Log
  
        	[bookmark: pgfId-1772462]Searching the Rule Update Import Log
  
       
 
        
        	[bookmark: pgfId-1772465]Applications
  
        	[bookmark: pgfId-1772470]Searching for Applications
  
       
 
        
        	[bookmark: pgfId-1772472]Security Intelligence Events
  
        	[bookmark: pgfId-1772476]Searching for Connection and Security Intelligence Data
  
       
 
        
        	[bookmark: pgfId-1772479]Users
  
        	[bookmark: pgfId-1772484]Searching for Users
  
       
 
        
        	[bookmark: pgfId-1772486]Vulnerabilities
  
        	[bookmark: pgfId-1772490]Searching for Vulnerabilities
  
       
 
        
        	[bookmark: pgfId-1772493]White List Events
  
        	[bookmark: pgfId-1772497]Searching for Compliance White List Events
  
       
 
        
        	[bookmark: pgfId-1772500]White List Violations
  
        	[bookmark: pgfId-1772504]Searching for White List Violations
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1772524]To implement these criteria in a table search, see the following procedure.
 
    [bookmark: pgfId-1748076][bookmark: 85901]To perform a search on a custom table:
 
    [bookmark: pgfId-1695148]Access: Any/Admin 
 
    
 
    [bookmark: pgfId-1786823]Step 1 Select Analysis > Custom > Custom Tables.
 
    [bookmark: pgfId-1786824]The Custom Tables page appears.
 ) next to the custom table you want to search. 
    
 
    [bookmark: pgfId-1786829]The first page of the default workflow for the custom table appears. To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear and the workflow can be constrained by time, you may need to adjust the time range; see Setting Event Time Constraints.
 
    [bookmark: pgfId-1786836]Step 3 Click Search.
 
    [bookmark: pgfId-1786837]The custom table’s search page appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-1786838]Tip To search the database for a different kind of event or data, select it from the table drop-down list.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1786841]Step 4 Enter your search criteria in the appropriate fields. For more information about choosing search criteria, see the Table Search Criteria table.
 
    [bookmark: pgfId-1788359]If you enter criteria for multiple fields, the search returns only the records that match search criteria specified for all fields. 
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-1786853]Step 5 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
    
     
   
 
   
 
   [bookmark: pgfId-1786854]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-1786855]Step 6 Optionally, you can save the search to be used again in the future. You have the following options:
 
    
     
     	 [bookmark: pgfId-1788416]Click  Save to save the search criteria.
 
    
 
   
 
   [bookmark: pgfId-1788417]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
    
     
     	 [bookmark: pgfId-1788418]Click  Save As New  to save a new search or assign a name to a search you created by altering a previously-saved search.
 
    
 
   
 
   [bookmark: pgfId-1788419]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
   [bookmark: pgfId-1786856]Step 7 Click Search to start the search.
 
   [bookmark: pgfId-1786857]Your search results appear in the default workflow for the custom table, constrained by the current time range (if applicable). To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. 
 
   [bookmark: pgfId-1782944]
 
    
    
 
   
 
   
 
   [bookmark: pgfId-1444582]
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1826081][bookmark: 72011]Searching[bookmark: marker-1826080] for Events 
      
      
 
     
 
 
    [bookmark: pgfId-1645384]Cisco appliances generate information that is stored as events in database tables. Events contain multiple fields that describe the activity that caused the appliance to generate the event.
 
    [bookmark: pgfId-1668895]The FireSIGHT System provides predefined searches that serve as examples and can provide quick access to important information about your network. You can modify fields within the predefined searches for your network environment, then save the searches to reuse later. You can also use your own search criteria.
 
    [bookmark: pgfId-1338226]The search criteria you can use depends on the type of search, but the mechanics are the same. See the following sections for more information on how to perform a search and on the correct syntax to use in search fields:
 
     
     	 [bookmark: pgfId-1335919]Performing and Saving Searches
 
     	 [bookmark: pgfId-1335890]Using Wildcards and Symbols in Searches
 
     	 [bookmark: pgfId-1788455]Using Objects and Application Filters in Searches
 
     	 [bookmark: pgfId-1335894]Specifying Time Constraints in Searches
 
     	 [bookmark: pgfId-1335898]Specifying IP Addresses in Searches
 
     	 [bookmark: pgfId-1836963]Specifying Devices in Searches
 
     	 [bookmark: pgfId-1335902]Specifying Ports in Searches
 
     	 [bookmark: pgfId-1815232]Stopping Long-Running Queries
 
    
 
   
 
    
     [bookmark: pgfId-1821241][bookmark: 11471]Performing and Saving Sear[bookmark: marker-1821240]ches
 
    [bookmark: pgfId-1821242]License: Any
 
    [bookmark: pgfId-1821243]You can create and save searches for any of the different event types. When you create a search you give it a name and specify whether the search will be available to you alone or to all users of the appliance. If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
    [bookmark: pgfId-1788664]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1643610]Performing a Search
 
     	 [bookmark: pgfId-1643656]Loading a Saved Search
 
     	 [bookmark: pgfId-1643691]Deleting a Saved Search
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1788326]Note To search a custom table, follow a slightly different procedure; see Searching Custom Tables.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-1840605][bookmark: 38247]Performing a Se[bookmark: marker-1840604]arch
 
     [bookmark: pgfId-1840609]License: Any
 
     [bookmark: pgfId-1821236]For some event types, the FireSIGHT System provides predefined searches that serve as examples and can provide quick access to important information about your network. You can modify fields within the predefined searches for your network environment, then save the searches to reuse later. You can also use your own search criteria.
 
     [bookmark: pgfId-1643630]To perform a search:
 
     [bookmark: pgfId-1770113]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1829949]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-1829950]The Search page appears.
 
     [bookmark: pgfId-1829951]Step 2 From the table drop-down list, select the type of event or data to search.
 
     [bookmark: pgfId-1833090]The page updates with the appropriate search constraints.
 
     [bookmark: pgfId-1833093]Step 3 Enter your search criteria in the appropriate fields: 
 
      
       
       	 [bookmark: pgfId-1829956]All fields accept negation ( ! ).
 
       	 [bookmark: pgfId-1829957]All fields accept comma-separated lists of search values. Records that contain any of the listed values in the specified field match that search criteria.
 
       	 [bookmark: pgfId-1834513]All fields accept comma-separated lists enclosed in quotation marks as search values.
 
      
 
     
 
     [bookmark: pgfId-1834532] – For fields that may contain only a single value, records with the specified field containing the exact string specified within the quotation marks match the search criteria. For instance, a search for A, B, "C, D, E" will match records where the specified field contains "A" or "B" or "C, D, E". This permits matching on fields that include the comma in possible values.
 
     [bookmark: pgfId-1834934] – For fields that may contain multiple values at the same time, records with the specified fields containing all of the values in the quote-enclosed comma-separated list match that search criteria.
 
     [bookmark: pgfId-1835181] – For fields that may contain multiple values at the same time, search criteria may include single values as well as quote-enclosed comma-separated lists. For instance, a search for A, B, "C, D, E" on a field that may contain one of more of these letters matches records where the specified field contains A or B, or all of C, D, and E.
 
      
       
       	 [bookmark: pgfId-1835567]Searches return only records that match the search criteria specified for all fields.
 
       	 [bookmark: pgfId-1829958]Many fields accept one or more asterisks ( * ) as wild cards.
 
       	 [bookmark: pgfId-1834406]Specify  n/a in any field to identify events where information is not available for that field; use  !n/a to identify the events where that field is populated.
 
       	 [bookmark: pgfId-1834413]Click the add object icon (
 
      
 
      [image: ] ) that appears next to a search field to use an object as a search criterion. 
     
 
     [bookmark: pgfId-1829964]Step 4 See the following sections for detailed information on the search criteria you can use:
 
      
       
       	 [bookmark: pgfId-1829968]Searching Audit Records
 
       	 [bookmark: pgfId-1829972]Searching for Applications
 
       	 [bookmark: pgfId-1829976]Searching for Application Details
 
       	 [bookmark: pgfId-1829980]Searching for Captured Files
 
       	 [bookmark: pgfId-1835716]Searching for Compliance White List Events
 
       	 [bookmark: pgfId-1829984]Searching for Connection and Security Intelligence Data
 
       	 [bookmark: pgfId-1829988]Searching for Correlation Events
 
       	 [bookmark: pgfId-1829992]Searching for Discovery Events
 
       	 [bookmark: pgfId-1829996]Searching for File Events
 
       	 [bookmark: pgfId-1830000]Searching for Health Events
 
       	 [bookmark: pgfId-1830004]Searching for Host Attributes
 
       	 [bookmark: pgfId-1830008]Searching for Hosts
 
       	 [bookmark: pgfId-1830012]Searching for Intrusion Events
 
       	 [bookmark: pgfId-1830016]Searching for Malware Events
 
       	 [bookmark: pgfId-1835787]Searching the Rule Update Import Log
 
       	 [bookmark: pgfId-1835791]Searching for Remediation Status Events
 
       	 [bookmark: pgfId-1830020]Searching for Scan Results
 
       	 [bookmark: pgfId-1830024]Searching for Servers
 
       	 [bookmark: pgfId-1835752]Searching for Third-Party Vulnerabilities
 
       	 [bookmark: pgfId-1835756]Searching for Users
 
       	 [bookmark: pgfId-1835760]Searching for User Activity
 
       	 [bookmark: pgfId-1830028]Searching for Vulnerabilities
 
       	 [bookmark: pgfId-1830056]Searching for White List Violations
 
      
 
     
 
     [bookmark: pgfId-1830057]Step 5 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-1830058]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1830059]Step 6 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-1836112]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-1836113]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-1836114]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-1836115]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-1835934]Step 7 Click Search to start the search.
 
     [bookmark: pgfId-1830061]Your search results appear in the default workflow for the table you are searching, constrained by time (if applicable). To use a different workflow, including a custom workflow, click (switch workflow) by the workflow title. For information on specifying a different default workflow, see Configuring Event View Settings. Note that you cannot use a different workflow for scan results.
 
     [bookmark: pgfId-1829940]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1829928][bookmark: 68709]Loading[bookmark: marker-1829927] a Saved Search
 
     [bookmark: pgfId-1784944]License: Any
 
     [bookmark: pgfId-1331713]If you previously saved a search, you can load it, make any necessary modifications, and then start the search. 
 
     [bookmark: pgfId-1331716][bookmark: marker-1331714][bookmark: marker-1331715]To load a saved search:
 
     [bookmark: pgfId-1704179]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1831874]Step 1 You have the following options:
 
      
       
       	 [bookmark: pgfId-1831875]From any page on a workflow, click  Search .
 
       	 [bookmark: pgfId-1831876]Select  Analysis > Search , then select the type of events you want to search for.
 
      
 
     
 
     [bookmark: pgfId-1831877]The Search page appears.
 
     [bookmark: pgfId-1831878]Step 2 Select the search you want to load from the Custom Searches list or the Predefined Searches list.
 
     [bookmark: pgfId-1831879]Settings from the saved search populate the search constraints.
 
     [bookmark: pgfId-1831880]Step 3 Optionally, change the search constraints.
 
     [bookmark: pgfId-1831881]Step 4 Click Search.
 
     [bookmark: pgfId-1831882]The events that match your search constraints appear.
 
     [bookmark: pgfId-1826367]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1331762][bookmark: 27971]Deleting a Sav[bookmark: marker-1719003]ed Search
 
     [bookmark: pgfId-1787640]License: Any
 
     [bookmark: pgfId-1331763]If you have saved searches, you can delete them from the Search page.
 
     [bookmark: pgfId-1331765][bookmark: marker-1331764]To delete a saved search:
 
     [bookmark: pgfId-1770696]Access: Admin/Any Security Analyst
 
     
 
     [bookmark: pgfId-1831920]Step 1 You have the following options:
 
      
       
       	 [bookmark: pgfId-1831921]From any page on a workflow, click  Search .
 
       	 [bookmark: pgfId-1831922]Select  Analysis > Search , then select the event type for the search that you want to delete.
 
      
 
     
 
     [bookmark: pgfId-1832813]The Search page appears.
 ) that appears next to the search name. 
     
 
     [bookmark: pgfId-1831925]The search is deleted.
 
     [bookmark: pgfId-1826389]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-1105872][bookmark: 30220]Using Wildcards and[bookmark: marker-1657706] Symbols in Searches
 
    [bookmark: pgfId-1785088]License: Any
 
    [bookmark: pgfId-1105873]Many text fields on search pages allow you to use an asterisk (*) to match characters in a string. For example, specifying net* matches network, netware, netscape, and so on.
 
    [bookmark: pgfId-1446586]If you want to search for non-alphanumeric characters (including the asterisk character), enclose the search string in quotation marks. For example, to search for the string:
 
     
     [bookmark: pgfId-1358961]Find an asterisk (*) 
    
 
    [bookmark: pgfId-1359026]enter:
 
     
     [bookmark: pgfId-1358997]"Find an asterisk (*)" 
    
 
    [bookmark: pgfId-1446792]Note that in text fields that allow a wildcard, you must use the wildcard if you want to match a partial string. For example, if you are searching the audit log for all audit records that involve page views (that is, the message is Page View), searching for Page returns no results. Instead, specify Page*.
 
   
 
    
     [bookmark: pgfId-1788464][bookmark: 81073]Using Objects and Appli[bookmark: marker-1793435]cation Filters in Searches
 
    [bookmark: pgfId-1788518]License: Any
 
    [bookmark: pgfId-1791171]The FireSIGHT System allows you to create named objects, object groups, and application filters that can be used as part of your network configuration. You can use these objects, groups, and filters as search criteria when performing or saving searches.
 
    [bookmark: pgfId-1791344]When you perform a search, objects, object groups, and application filters appear in the format, ${object_name}. For example, a network object with the object name ten_ten_network appears as ${ten_ten_network} in a search.
 ) that appears next to a search field where you can use an object as a search criterion. 
    
 
   
 
    
     [bookmark: pgfId-1113340][bookmark: 36404]Specifying Time[bookmark: marker-1657707] Constraints in Searches
 
    [bookmark: pgfId-1785122]License: Any
 
    [bookmark: pgfId-1115974]You can use a number of formats for specifying time search constraints. You can enter a time you want to match, and, optionally, a less than (<) or greater than (>) operator to match times before or after the time you enter.
 
     
      
       
       [bookmark: pgfId-1116613]Table 60-1 [bookmark: 40876]Time Specification in Search Fields 
 
       
       
        
        	 
          
          [bookmark: pgfId-1116617]Time Formats 
         
  
        	 
          
          [bookmark: pgfId-1116619]Example 
         
  
       
 
        
        	[bookmark: pgfId-1116625]today [at HH:MMam|pm]
  
        	[bookmark: pgfId-1116627]today
 [bookmark: pgfId-1116714]today at 12:45pm
  
       
 
        
        	[bookmark: pgfId-1467492]YYYY-MM-DD HH:MM:SS
  
        	[bookmark: pgfId-1467494]2006-03-22 14:22:59
  
       
 
       
     
 
    
 
     
      
       
       [bookmark: pgfId-1116824]Table 60-2 Time Specification Operators 
 
       
       
        
        	 
          
          [bookmark: pgfId-1116828]Operator 
         
  
        	 
          
          [bookmark: pgfId-1117075]Example 
         
  
        	 
          
          [bookmark: pgfId-1116830]Explanation 
         
  
       
 
        
        	[bookmark: pgfId-1116832]< 
  
        	[bookmark: pgfId-1117077]< 2006-03-22 14:22:59
  
        	[bookmark: pgfId-1116834]Returns events with a timestamp before 2:23 PM, March 22, 2006.
  
       
 
        
        	[bookmark: pgfId-1116836]> 
  
        	[bookmark: pgfId-1117079]> today at 2:45pm
  
        	[bookmark: pgfId-1116838]Returns events with a timestamp later than today at 2:45 PM.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1644108][bookmark: 59483]Specifying IP Addresses in Searches
 
    [bookmark: pgfId-1785156]License: Any
 
    [bookmark: pgfId-1803149][bookmark: 14084]When s[bookmark: marker-1803147][bookmark: syntax for IP addresses]pecifying IP addresses in searches, you can enter an individual IP address, a comma-separated list of addresses, an address block, or a range of IP addresses separated with a hyphen (-). You can also use negation.
 
    [bookmark: pgfId-1803150]For searches that support IPv6 (such as intrusion event, connection data, and correlation event searches) you can enter IPv4 and IPv6 addresses and CIDR/prefix length address blocks in any combination.
 
    [bookmark: pgfId-1797466]When you use CIDR or prefix length notation to specify a block of IP addresses, the FireSIGHT System uses only the portion of the network IP address specified by the mask or prefix length. For example, if you type 10.1.2.3/8, the FireSIGHT System uses 10.0.0.0/8.
 ) that appears next to an IP address search field to use a network object as an IP address search criterion. For more information, see 
    Using Objects and Application Filters in Searches. 
    
 
    [bookmark: pgfId-1798535]
 
     
      
       
       [bookmark: pgfId-1809000]Table 60-3 Acceptable IP Address Syntax 
 
       
       
        
        	 
          
          [bookmark: pgfId-1809006]To specify... 
         
  
        	 
          
          [bookmark: pgfId-1809008]Type... 
         
  
        	 
          
          [bookmark: pgfId-1809010]For example... 
         
  
       
 
        
        	[bookmark: pgfId-1809012]a single IP address
  
        	[bookmark: pgfId-1809014]the IP address.
  
        	[bookmark: pgfId-1809016]192.168.1.1
 [bookmark: pgfId-1809017]2001:db8::abcd
  
       
 
        
        	[bookmark: pgfId-1809019]multiple IP addresses using a list
  
        	[bookmark: pgfId-1809021]a comma-separated list of IP addresses. Do not add a space before or after the commas.
  
        	[bookmark: pgfId-1809023]192.168.1.1,192.168.1.2
 [bookmark: pgfId-1809024]2001:db8::b3ff,2001:db8::0202
  
       
 
        
        	[bookmark: pgfId-1809026]a range of IP addresses that can be specified with a CIDR block or prefix length
  
        	[bookmark: pgfId-1809028]the IP address block in IPv4 CIDR or IPv6 prefix length notation.
  
        	[bookmark: pgfId-1809030]192.168.1.0/24
 [bookmark: pgfId-1809031]This specifies any IP in the 192.168.1.0 network with a subnet mask of 255.255.255.0, that is, 192.168.1.0 through 192.168.1.255. For more information, see IP Address Conventions.
  
       
 
        
        	[bookmark: pgfId-1809036]a range of IP addresses that cannot be specified with a CIDR block or prefix
  
        	[bookmark: pgfId-1809038]the IP address range using a hyphen. Do not add a space before or after the hyphen.
  
        	[bookmark: pgfId-1809040]192.168.1.1-192.168.1.5
 [bookmark: pgfId-1809041]2001:db8::0202-2001:db8::8329
  
       
 
        
        	[bookmark: pgfId-1809043]negation of any of the other ways to specify IP addresses or ranges of IP addresses
  
        	[bookmark: pgfId-1809045]an exclamation point in front of the IP address, block, or range.
  
        	[bookmark: pgfId-1809047]192.168.0.0/32,!192.168.1.10
 [bookmark: pgfId-1809048]!2001:db8::/32
 [bookmark: pgfId-1809049]!192.168.1.10,!2001:db8::/32
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1644618][bookmark: 99731]Specifying Devices in[bookmark: marker-1837021] Searches
 
    [bookmark: pgfId-1837047]License: Any
 
    [bookmark: pgfId-1837028]When creating a search using a managed device as a constraint, you can specify any of the following in the Device search criteria field:
 
     
     	 [bookmark: pgfId-1837200]A managed device name, IP address, or host name
 
     	 [bookmark: pgfId-1837354]A device group name
 
     	 [bookmark: pgfId-1837510]A device stack name
 
     	 [bookmark: pgfId-1837650]A device cluster name
 
    
 
    [bookmark: pgfId-1837960]If the system finds a match for a group, cluster, or stack, it replaces the group, cluster, or stack name with the appropriate member device names for the purpose of performing the search. When you save a search that uses a device group, cluster, or stack in the device field the system saves the name specified in the device field and performs the device name replacement again each time the search is executed.
 
    [bookmark: pgfId-1840223]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1840227]Working with Devices
 
     	 [bookmark: pgfId-1840231]Managing Device Groups
 
     	 [bookmark: pgfId-1840235]Managing Stacked Devices
 
     	 [bookmark: pgfId-1840239]Clustering Devices
 
    
 
   
 
    
     [bookmark: pgfId-1837493][bookmark: 38222]Specifying Ports in[bookmark: marker-1837492] Searches
 
    [bookmark: pgfId-1837497]License: Any
 
    [bookmark: pgfId-1114315]The FireSIGHT System accepts specific syntax for port numbers in searches. You can enter:
 
     
     	 [bookmark: pgfId-1114585]a single port number
 
     	 [bookmark: pgfId-1114604]a comma-separated list of port numbers
 
     	 [bookmark: pgfId-1114621]two port numbers separated by a dash to represent a range of port numbers
 
     	 [bookmark: pgfId-1664677]a port number followed by a protocol abbreviation, separated by a forward slash (only when searching for intrusion events)
 
     	 [bookmark: pgfId-1473382]a port number or range of port numbers preceded by an exclamation mark to indicate a negation of the specified ports
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-1115565]Note Do not use spaces when specifying port numbers or ranges.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1477057]The following table contains examples of valid ways to enter ports as search constraints.
 
    [bookmark: pgfId-1811861]\
 
     
      
       
       [bookmark: pgfId-1811834]Table 60-4 [bookmark: 96186]Port Syntax Examples 
 
       
       
        
        	 
          
          [bookmark: pgfId-1811838]Example 
         
  
        	 
          
          [bookmark: pgfId-1811840]Description 
         
  
       
 
        
        	[bookmark: pgfId-1811842]21
  
        	[bookmark: pgfId-1811844]Returns all events on port 21, including TCP and UDP events.
  
       
 
        
        	[bookmark: pgfId-1811846]!23
  
        	[bookmark: pgfId-1811848]Returns all events except those on port 23.
  
       
 
        
        	[bookmark: pgfId-1811850]25/tcp
  
        	[bookmark: pgfId-1811852]Returns all TCP-related intrusion events on port 25.
  
       
 
        
        	[bookmark: pgfId-1811854]21/tcp,25/tcp
  
        	[bookmark: pgfId-1811856]Returns all TCP-related intrusion events on ports 21 and 25
  
       
 
        
        	[bookmark: pgfId-1811858]21-25
  
        	[bookmark: pgfId-1811860]Returns all events on ports 21 through 25.
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-1811891][bookmark: 90808]Stopping Long-Running Queries
 
    [bookmark: pgfId-1811899]License: Any
 
    [bookmark: pgfId-1811924]Supported Devices: Any Defense Center
 
    [bookmark: pgfId-1811915]System administrators can use a shell-based query management tool to locate and stop long-running queries. 
 
     
      
    
 
    
 
    [bookmark: pgfId-1812759]Note Leaving the search page in the web interface does not stop a query. Queries that take a long time to return results impact overall system performance while the query is running.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1813576]The query management tool allows you to locate queries running longer than a specified number of minutes and stop those queries. The tool logs an event to the audit log and to syslog when you stop a query. 
 
    [bookmark: pgfId-1812756]Note that the only locally-created user with shell access on Defense Centers is the admin user. If you use an external authentication object which grants shell access, users matching the shell access filter can also log into the shell. 
 
    [bookmark: pgfId-1813887]Usage:
 
     
     [bookmark: pgfId-1813888]query_manager [-v] [-l [minutes]] [-k query_id [...]] 
[--kill-all minutes] 
    
 
    [bookmark: pgfId-1814929]Options:
 
     
     [bookmark: pgfId-1814930]-h, --help 
    
 
    [bookmark: pgfId-1814931] Prints a brief help message.
 
     
     [bookmark: pgfId-1814933]-l, --list [minutes] 
    
 
    [bookmark: pgfId-1814934] Lists all queries taking longer than passed in minutes. By
 
    [bookmark: pgfId-1814935] default it will show all queries taking longer than 1 minute.
 
     
     [bookmark: pgfId-1814937]-k, --kill query_id [...] 
    
 
    [bookmark: pgfId-1814938] Kills the query with the passed in id. The option can take
 
    [bookmark: pgfId-1814939] multiple ids.
 
     
     [bookmark: pgfId-1814941]--kill-all minutes 
    
 
    [bookmark: pgfId-1814942] Kills all queries taking longer than passed in minutes.
 
     
     [bookmark: pgfId-1814944]-v, --verbose 
    
 
    [bookmark: pgfId-1814925] Verbose output including full SQL queries.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-1813179] 
     Caution Shell access should be limited to system administrators. 
      
      
 
     
 
    
 
    [bookmark: pgfId-1812743]To stop a query on the Defense Center:
 
    [bookmark: pgfId-1813091]Access: admin or other user granted shell access
 
    
 
    [bookmark: pgfId-1813176]Step 1 Connect to the Defense Center via ssh.
 
    [bookmark: pgfId-1813468]Step 2 Run query_manager under sudo using the syntax described above.
 
    [bookmark: pgfId-1826448]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1821093]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-6107633][bookmark: 36881]Managing U[bookmark: marker-6107632]sers 
      
      
 
     
 
 
    [bookmark: pgfId-6121187]If your user account has Administrator access, you can manage the user accounts that can access the web interface on your Defense Center or managed device. On the Defense Center, you can also set up user authentication via an external authentication server, rather than through the internal database.
 
    [bookmark: pgfId-5885926]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-5885930]Understanding Cisco User Authentication
 
     	 [bookmark: pgfId-6367000]Managing Authentication Objects
 
     	 [bookmark: pgfId-5885938]Managing User Accounts
 
     	 [bookmark: pgfId-5885942]Managing User Role Escalation
 
     	 [bookmark: pgfId-6121326]Configuring Single Sign-on from Cisco Security Manager
 
    
 
   
 
    
     [bookmark: pgfId-6225420][bookmark: 12223]Understanding Cisco User[bookmark: marker-6225419] Authentication
 
    [bookmark: pgfId-6225424]License: Any
 
    [bookmark: pgfId-6225425]When a user logs into the web interface, the appliance looks for a match for the user name and password in the local list of users. This process is called authentication. There are two kinds of authentication: internal and external. If the user’s account uses internal authentication, the authentication process checks the local database for this list. If the account uses external authentication, the process checks the local database to see if the user exists there and, if the user is not found locally, it queries an external server, such as a Lightweight Directory Access Protocol (LDAP) directory server or a Remote Authentication Dial In User Service (RADIUS) authentication server, for a list of users. 
 
    [bookmark: pgfId-6647418]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-5885969]For users with either internal or external authentication, you can control user permissions. Users with external authentication receive the permissions either for the group or access list they belong to, or based on the default user access role you set in the server authentication object or in a system policy on the managing Defense Center, unless you change the user permissions manually. 
 
    [bookmark: pgfId-5885973]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-5885977]Understanding Internal Authentication
 
     	 [bookmark: pgfId-5885981]Understanding External Authentication
 
     	 [bookmark: pgfId-5885985]Understanding User Privileges
 
    
 
     
      [bookmark: pgfId-5885988][bookmark: 25753]Understanding[bookmark: marker-5885987] Internal Authentication
 
     [bookmark: pgfId-5885999]License: Any
 
     [bookmark: pgfId-5960793]By default, the FireSIGHT System uses internal authentication to check user credentials when a user logs in. Internal authentication occurs when the user name and password are verified against records in the internal FireSIGHT System database. If you do not enable external authentication when you create a user, the user credentials are managed in the internal database. 
 
     [bookmark: pgfId-5886007]Because you manually create each internally authenticated user, you set the access rights when you create the user and you do not need to set default settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-5886008]Note Note that an internally authenticated user is converted to external authentication if you enable external authentication, the same user name exists for the user on the external server, and the user logs in using the password stored for that user on the external server. After an internally authenticated user converts to an externally authenticated user, you cannot revert to internal authentication for that user. 
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5886011][bookmark: 79571]Understanding[bookmark: marker-5886010] External Authentication
 
     [bookmark: pgfId-5886016]License: Any
 
     [bookmark: pgfId-5886020]External authentication occurs when the Defense Center or managed device retrieves user credentials from an external repository, such as an LDAP directory server or RADIUS authentication server. LDAP authentication and RADIUS authentication are types of external authentication. Note that you can only use one form of external authentication for an appliance. 
 
     [bookmark: pgfId-5886021]If you want to use external authentication, you must configure an authentication object for each external authentication server where you want to request user information. The authentication object contains your settings for connecting to and retrieving user data from that server. You can then enable that object in a system policy on the managing Defense Center and apply the policy to an appliance to enable authentication. When any externally authenticated user logs in, the web interface checks each authentication server to see if that user is listed, in the order the servers are listed in the system policy. 
 
     [bookmark: pgfId-5886025]When you create a user, you can specify whether that user is internally or externally authenticated. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6110578]Note Before enabling external authentication on Series 3 managed devices, remove any internally-authenticated shell users that have the same user name as externally-authenticated users included in your shell access filter.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6110007]You can push a system policy to a managed device to enable external authentication on that device, but you cannot control the authentication object from the device’s web interface. The only configuration of external authentication on the device occurs when you select the type of authentication for a new user. If you want to disable external authentication on a managed device, disable it in the system policy on the managing Defense Center and reapply the policy to the device. If you apply a local system policy (created on the managed device) to the device itself, external authentication is also disabled. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5886026]Tip You can use the Import/Export feature to export system policies. When you export a policy with external authentication enabled, the authentication objects are exported with the policy. You can then import the policy and object on another Defense Center. Do not import policies with authentication objects onto managed devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5886050]For more information on specific types of external authentication, see the following sections:
 
      
      	 [bookmark: pgfId-6367024]LDAP Authentication
 
      	 [bookmark: pgfId-6367028]RADIUS Authentication
 
     
 
    
 
     
      [bookmark: pgfId-5886061][bookmark: 18193]Understanding[bookmark: marker-5886060] User Privileges
 
     [bookmark: pgfId-5961265]License: Any
 
     [bookmark: pgfId-5886065]The FireSIGHT System lets you allocate user privileges based on the user’s role. For example, an analyst typically needs access to event data to analyze the security of monitored networks, but might never require access to administrative functions for the FireSIGHT System itself. You can grant analysts predefined roles such as Security Analyst and Discovery Admin and reserve the Administrator role for the network administrator managing the FireSIGHT System. You can also create custom user roles with access privileges tailored to your organization’s needs.
 
     [bookmark: pgfId-5886078]In the system policy on the Defense Center, you set a default access role for all users who are externally authenticated. After an externally authenticated user logs in for the first time, you can add or remove access rights for that user on the User Management page. If you do not modify the user’s rights, the user has only the rights granted by default. Because you create internally authenticated users manually, you set the access rights when you create them.
 
     [bookmark: pgfId-5886079]If you configured management of access rights through LDAP groups, the access rights for users are based on their membership in LDAP groups. They receive the default access rights for the group that they belong to that has the highest level of access. If they do not belong to any groups and you have configured group access, they receive the default user access rights configured in the authentication object for the LDAP server. If you configure group access, those settings override the default access setting in the system policy. 
 
     [bookmark: pgfId-5886080]Similarly, if you assign a user to specific user role lists in a RADIUS authentication object, the user receives all assigned roles, unless one or more of those roles are mutually incompatible. If a user is on the lists for two mutually incompatible roles, the user receives the role that has the highest level of access. If the user does not belong to any lists and you have configured a default access role in the authentication object, the user receives that role. If you configure default access in the authentication object, those settings override the default access setting in the system policy. 
 
     [bookmark: pgfId-5886084]The FireSIGHT System supports the following predefined user roles, listed in order of precedence, depending on the features you have licensed:
 
      
      	 [bookmark: pgfId-5929668] Access Admins can view and modify access control and file policies, but cannot apply their policy changes.
 
      	 [bookmark: pgfId-5929669] Administrators  can set up the appliance’s network configuration, manage user accounts and Collective Security Intelligence Cloud connections, and configure system policies and system settings. Users with the Administrator role have all rights and privileges of all other roles (with the exception of lesser, restricted versions of those privileges).
 
      	 [bookmark: pgfId-5915624] Discovery Admins can review, modify and delete network discovery policies, but cannot apply their policy changes.
 
      	 [bookmark: pgfId-5902734] External Database users can query the FireSIGHT System database using an external application that supports JDBC SSL connections. On the web interface, they can access the online help and user preferences.
 
      	 [bookmark: pgfId-5902711] Intrusion Admins have access to all intrusion policy, intrusion rule, and network analysis policy features. Intrusion Admins have access to intrusion-related options in the  Policies menu. Note that Intrusion Admins cannot apply intrusion or network analysis policies as part of access control policies.
 
      	 [bookmark: pgfId-5902968] Maintenance Users  can access monitoring functions (including health monitoring, host statistics, performance data, and system logs) and maintenance functions (including task scheduling and backing up the system). 
 
     
 
     [bookmark: pgfId-5902969]Note that maintenance users do not have access to the functions in the Policies menu and can only access the dashboard from the Analysis menu. 
 
      
      	 [bookmark: pgfId-5902858] Network Admins can review, modify, and apply device configurations as well as review and modify access control policies.
 
      	 [bookmark: pgfId-5902872] Security Approvers can view and apply, but not create, configuration and policy changes.
 
      	 [bookmark: pgfId-5902903] Security Analysts can review, analyze, and delete intrusion, discovery, user activity, connection, correlation, and network change events. They can review, analyze, and (when applicable) delete hosts, host attributes, services, vulnerabilities, and client applications. Security Analysts can also generate reports and view (but not delete or modify) health events.
 
      	 [bookmark: pgfId-5886093] Security Analysts (Read Only)  have all the same rights as Security Analysts, except that they cannot delete events.
 
     
 
     [bookmark: pgfId-5886118]In addition to the above predefined roles, you can also configure custom user roles with specialized access privileges. Any role can be the default access role for externally authenticated users.
 
     [bookmark: pgfId-5886119]You can grant user role escalation privileges to externally authenticated user accounts; you can also use an externally authenticated user’s password as the escalation password. For more information, see Managing User Role Escalation.
 
    
 
   
 
    
     [bookmark: pgfId-6367312][bookmark: 59331]Managing Auth[bookmark: marker-6367310]entication Objects
 
    [bookmark: pgfId-6367317]License: Any
 
    [bookmark: pgfId-6367319]Authentication objects are server profiles for external authentication servers, containing connection settings and authentication filter settings for those servers. You can create, configure, and delete authentication objects on the Defense Center and use them to manage external authentication to LDAP or RADIUS servers. See the following sections for details:
 
     
     	 [bookmark: pgfId-6449925]LDAP Authentication
 
     	 [bookmark: pgfId-6449929]RADIUS Authentication
 
     	 [bookmark: pgfId-6449933]Deleting Authentication Objects
 
    
 
     
      [bookmark: pgfId-6449905][bookmark: 99294]LDAP Authe[bookmark: marker-6449912]ntication
 
     [bookmark: pgfId-6449909]License: Any
 
     [bookmark: pgfId-6367342]LDAP, or the Lightweight Directory Access Protocol, allows you to set up a directory on your network that organizes objects, such as user credentials, in a centralized location. Multiple applications can then access those credentials and the information used to describe them. If you ever need to change a user's credentials, you can change them in one place, rather than having to change them on each FireSIGHT System appliance.
 
     [bookmark: pgfId-6367346]See the following sections for more information:
 
      
      	 [bookmark: pgfId-6367350]Understanding LDAP Authentication
 
      	 [bookmark: pgfId-6367354]Understanding LDAP Authentication With CAC
 
      	 [bookmark: pgfId-6367358]Preparing to Create an LDAP Authentication Object
 
      	 [bookmark: pgfId-6367362]Creating Basic LDAP Authentication Objects
 
      	 [bookmark: pgfId-6367366]Creating Advanced LDAP Authentication Objects
 
      	 [bookmark: pgfId-6367370]LDAP Authentication Object Examples
 
      	 [bookmark: pgfId-6367374]Editing LDAP Authentication Objects
 
     
 
    
 
     
      [bookmark: pgfId-6367377][bookmark: 90816]Understanding LDAP Authentic[bookmark: marker-6367376]ation
 
     [bookmark: pgfId-6367381]License: Any
 
     [bookmark: pgfId-6367389]You can create LDAP authentication objects on a Defense Center, but not on other FireSIGHT System appliances. However, you can use the external authentication object on any appliance (except virtual devices or Cisco NGIPS for Blue Coat X-Series) by applying a system policy where the object is enabled to the appliance. When you apply the policy, the object is copied to the appliance. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6367396]Note Before enabling external authentication on Series 3 managed devices, remove any internally-authenticated shell users that have the same user name as externally-authenticated users included in your shell access filter.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367397]Note that you can use LDAP naming standards for address specification and for filter and attribute syntax in your authentication object. For more information, see the RFCs listed in the Lightweight Directory Access Protocol (v3): Technical Specification, RFC 3377. Examples of syntax are provided throughout this procedure. Note that when you set up an authentication object to connect to a Microsoft Active Directory Server, you can use the address specification syntax documented in the Internet RFC 822 (Standard for the Format of ARPA Internet Text Messages) specification when referencing a user name that contains a domain. For example, to refer to a user object, you might type JoeSmith@security.example.com rather than the equivalent user distinguished name of cn=JoeSmith,ou=security, dc=example,dc=com when using Microsoft Active Directory Server.
 
      
       
     
 
     
 
     [bookmark: pgfId-6367401]Note Currently, the FireSIGHT System supports LDAP external authentication on LDAP servers running [bookmark: marker-6367402]Microsoft Active Directory on Windows Server 2008, Oracle Directory Server Enterprise Edition 7.0 on and Windows Server 2008, or [bookmark: marker-6367403]OpenLDAP on Linux. However, the FireSIGHT System does not support external authentication for virtual devices or Cisco NGIPS for Blue Coat X-Series.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367410]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-6367414]Understanding Defaults
 
      	 [bookmark: pgfId-6367418]Understanding Base DNs
 
      	 [bookmark: pgfId-6367422]Understanding Base Filters
 
      	 [bookmark: pgfId-6367426]Understanding Impersonation Accounts
 
      	 [bookmark: pgfId-6367430]Understanding Your LDAP Connection
 
      	 [bookmark: pgfId-6367434]Understanding User Name Templates
 
      	 [bookmark: pgfId-6367438]Understanding Connection Timeouts
 
      	 [bookmark: pgfId-6367442]Understanding Attributes to Manage Access
 
      	 [bookmark: pgfId-6367446]Understanding Group Membership to Manage Access
 
      	 [bookmark: pgfId-6367450]Understanding Shell Access
 
     
 
    
 
     
      [bookmark: pgfId-6367452][bookmark: 88671]Understanding Defaults
 
     [bookmark: pgfId-6367456]License: Any
 
     [bookmark: pgfId-6367458]You can populate several fields using default values based on the server type you plan to connect to. Default values propagate the User Name Template, UI Access Attribute, Shell Access Attribute, Group Member Attribute, and Group Member URL Attribute fields when you select a server type and set defaults. 
 
    
 
     
      [bookmark: pgfId-6367460][bookmark: 80511]Understanding Base DNs
 
     [bookmark: pgfId-6367464]License: Any
 
     [bookmark: pgfId-6367466]When the local appliance searches the LDAP server to retrieve user information on the authentication server, it needs a starting point for that search. You can specify the tree that the local appliance should search by providing a base distinguished name, or base DN. 
 
     [bookmark: pgfId-6367467]Typically, the base DN has a basic structure indicating the company domain and operational unit. For example, the Security organization of the Example company might have a base DN of ou=security,dc=example,dc=com. 
 
     [bookmark: pgfId-6367468]After you identify a primary server, you can automatically retrieve a list of available base DNs from it and select the appropriate base DN.
 
    
 
     
      [bookmark: pgfId-6367470][bookmark: 26401]Understanding Base Filters
 
     [bookmark: pgfId-6367474]License: Any
 
     [bookmark: pgfId-6367476]You can add a base filter (maximum 450 characters, including the enclosing parentheses) that sets a specific value for a specific attribute. The base filter focuses your search by only retrieving objects in the base DN that have the attribute value set in the filter. Enclose the base filter in parentheses. For example, to filter for only users with a common name starting with F, use the filter (cn=F*).
 
     [bookmark: pgfId-6367479]To test your base filter more specifically by entering a test user name and password, see Testing User Authentication.
 
    
 
     
      [bookmark: pgfId-6367482][bookmark: 78313]Understanding Impersonation Accounts
 
     [bookmark: pgfId-6367486]License: Any
 
     [bookmark: pgfId-6367488]To allow the local appliance to access the user objects, you must supply user credentials for an impersonation account. The impersonation account is a user account with appropriate rights to browse the directory named by the base DN and retrieve the user objects you want to retrieve. Remember that the distinguished name for the user you specify must be unique to the tree for the server. 
 
    
 
     
      [bookmark: pgfId-6367490][bookmark: 81452]Understanding Your LDAP Connection
 
     [bookmark: pgfId-6367494]License: Any
 
     [bookmark: pgfId-6367496]You can manage the encryption method for your LDAP connection. You can choose no encryption, Transport Layer Security (TLS), or Secure Sockets Layer (SSL) encryption. 
 
     [bookmark: pgfId-6367497]Note that if you are using a certificate to authenticate when connecting via TLS or SSL, the name of the LDAP server in the certificate must match the name that you use in the Host Name/IP Address field. For example, if you enter 10.10.10.250 in the external authentication settings and computer1.example.com in the certificate, the connection fails. Changing the name of the server in the external authentication settings to computer1.example.com causes the connection to succeed. 
 
    
 
     
      [bookmark: pgfId-6367499][bookmark: 51656]Understanding User Name Templates
 
     [bookmark: pgfId-6367503]License: Any
 
     [bookmark: pgfId-6367505]Selecting a user name template lets you indicate how user names entered on login should be formatted, by mapping the string conversion character (%s) to the value of the UI access attribute or shell access attribute for the user. The user name template is the format for the distinguished name used for authentication. When a user enters a user name into the login page, the name is substituted for the string conversion character and the resulting distinguished name is used to search for the user credentials. 
 
     [bookmark: pgfId-6367506]For example, to set a user name template for the Security organization of the Example company, you might enter %s@security.example.com. If you want to use an object for CAC authentication and authorization, you must enter a value for the user name template that corresponds with your UI access attribute value. For more information, see Understanding LDAP Authentication With CAC.
 
    
 
     
      [bookmark: pgfId-6367511][bookmark: 99069]Understanding Connection Timeouts
 
     [bookmark: pgfId-6367515]License: Any
 
     [bookmark: pgfId-6367517]If you specify a backup authentication server, you can set a timeout for the connection attempt to the primary server. If the timeout period elapses without a response from the primary authentication server, the appliance then queries the backup server. For example, if the primary server has LDAP disabled, the appliance queries the backup server. 
 
     [bookmark: pgfId-6367518]If LDAP is running on the port of the primary LDAP server and for some reason refuses to service the request (due to misconfiguration or other issues), however, the failover to the backup server does not occur. 
 
    
 
     
      [bookmark: pgfId-6367520][bookmark: 49290]Understanding Attributes to Manage Access
 
     [bookmark: pgfId-6367524]License: Any
 
     [bookmark: pgfId-6367526]Different types of LDAP servers use different attributes to store user data. See the following sections for an explanation of UI and shell access attributes.
 
     [bookmark: pgfId-6571427]UI Access Attributes
 
     [bookmark: pgfId-6571228]If your LDAP server uses a UI access attribute of uid, the local appliance checks the uid attribute value for each object in the tree indicated by the base DN you set. If you do not set a specific UI access attribute, the local appliance checks the distinguished name for each user record on the LDAP server to see if it matches the user name. If one of the objects has a matching user name and password, the user login request is authenticated. 
 
     [bookmark: pgfId-6450018]You can substitute a different LDAP attribute to make the local appliance match a user name with that attribute rather than the value of the distinguished name. Selecting a server type and setting defaults fills in a UI access attribute appropriate for that type of server. If one of the objects has a matching user name and, for non-CAC objects, a password as a value for the attribute you specify, the user login request is authenticated. You can use any attribute, if the value of the attribute is a valid user name for the FireSIGHT System web interface. Valid user names are unique, and can include underscores (_), periods (.), hyphens (-), and alphanumeric characters. If you want to use an object for CAC authentication and authorization, you must enter a value for the UI access attribute that corresponds with the user name template value. For more information, see Understanding LDAP Authentication With CAC.
 
     [bookmark: pgfId-6367534]Shell Access Attributes
 
     [bookmark: pgfId-6571298]If your LDAP server uses uid as your shell access attribute, the local appliance checks the user name entered on login against the attribute value of uid. You can also set a custom shell access attribute other than uid. 
 
     [bookmark: pgfId-6367535]Note that selecting a server type and setting defaults prepopulates a shell access attribute typically appropriate for that type of server. You can use any attribute, if the value of the attribute is a valid user name for shell access. Valid user names are unique, and can include underscores (_), periods (.), hyphens (-), and alphanumeric characters. 
 
    
 
     
      [bookmark: pgfId-6367537][bookmark: 71193]Understanding Group Membership to Manage Access
 
     [bookmark: pgfId-6367541]License: Any
 
     [bookmark: pgfId-6367543]If you prefer to base default access rights on a user’s membership in an LDAP group, you can specify distinguished names for existing groups on your LDAP server for each of the access roles used by your FireSIGHT System. When you do so, you can configure a default access setting for those users detected by LDAP that do not belong to any specified groups. When a user logs in, the FireSIGHT System dynamically checks the LDAP server and assigns access rights according to the user’s current group membership.
 
     [bookmark: pgfId-6367553]When a user authenticated by an LDAP server logs into a local FireSIGHT System appliance for the first time, the user receives the access rights for groups the user belongs to, or if groups are not configured, the default access setting you selected in the system policy. 
 
     [bookmark: pgfId-6367554]You can then modify those settings, unless the settings are granted through group membership.
 
    
 
     
      [bookmark: pgfId-6367556][bookmark: 72987]Understanding Shell Access
 
     [bookmark: pgfId-6367560]License: Any
 
     [bookmark: pgfId-6367564]You can use the LDAP server to authenticate accounts for shell access on a managed device or Defense Center. Specify a search filter that retrieves entries for users to whom you want to grant shell access. Note that you can only configure shell access for the first authentication object in your system policy. For more information on managing authentication object order, see Enabling External Authentication.
 
     [bookmark: pgfId-6367569]With the exception of the admin account, shell access is controlled entirely though the shell access attribute you set. Shell users are configured as local users on the appliance. The filter you set here determines which set of users on the LDAP server can log into the shell. 
 
     [bookmark: pgfId-6367570]Note that a home directory for each shell user is created on login, and when an LDAP shell access user account is disabled (by disabling the LDAP connection), the directory remains, but the user shell is set to /bin/false in /etc/password to disable the shell. If the user then is re-enabled, the shell is reset, using the same home directory. 
 
     [bookmark: pgfId-6367571]If all users qualified in the base DN are also qualified for shell access privileges, you can configure the shell access filter to search more efficiently by selecting Same as Base Filter. Normally, the LDAP query to retrieve users combines the base filter with the shell access filter. If you type the same shell access filter as the base filter, the same query runs twice, which is unnecessarily time-consuming. 
 
     [bookmark: pgfId-6367572]Shell users can log in using user names with lowercase letters.Login authentication for the shell is case sensitive.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-6367579] 
      Caution On Series 3 Defense Centers, all shell users have 
      sudoers privileges. Make sure that you restrict the list of users with shell access appropriately. On Series 3 and virtual devices, shell access granted to externally authenticated users defaults to the 
      Configuration level of command line access, which also grants 
      sudoers privileges. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-6367584][bookmark: 73433]Understanding LDAP Authentication[bookmark: marker-6449941] With CAC
 
     [bookmark: pgfId-6367588]License: Any
 
     [bookmark: pgfId-6367590]If your organization uses Common Access Cards (CACs), you can configure LDAP authentication to authenticate users logging into the web interface and authorize access to specific functionality based on group membership or default access rights. With CAC authentication and authorization configured, users have the option to log in directly without providing a separate username and password for the appliance.
 
      
       
     
 
     
 
     [bookmark: pgfId-6367591]Note You must have a valid user certificate present in your browser (in this case, a certificate passed to your browser via your CAC) to enable user certificates as part of the CAC configuration process. After you configure CAC authentication and authorization, users on your network must maintain the CAC connection for the duration of their browsing session. If you remove or replace a CAC during a session, your web browser terminates the session and the system logs you out of the web interface.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367592]For more information about configuring and managing CAC authentication and authorization, see the following sections:
 
      
      	 [bookmark: pgfId-6367596]Configuring CAC Authentication and Authorization
 
      	 [bookmark: pgfId-6367600]Managing CAC Authentication and Authorization
 
     
 
    
 
     
      [bookmark: pgfId-6367602][bookmark: 30297]Configuring CAC Authentication and Authorization
 
     [bookmark: pgfId-6367606]License: Any 
 
     [bookmark: pgfId-6367613]Supported Devices: Any except virtual or X-Series
 
     [bookmark: pgfId-6367620]Supported Defense Centers: Any except virtual or X-Series
 
     [bookmark: pgfId-6367622]Before users on your network can log in using their CAC credentials, a user with appropriate permissions must complete the multi-step configuration process for CAC authentication and authorization.
 
     [bookmark: pgfId-6367623]To configure and enable CAC authentication and authorization:
 
     [bookmark: pgfId-6367627]Access: Admin/Network Admin
 
     
 
     [bookmark: pgfId-6367629]Step 1 [bookmark: 12942]Insert a CAC as directed by your organization.
 
     [bookmark: pgfId-6367630]Step 2 Direct your browser to https://hostname/, where hostname corresponds to the host name of your Defense Center.
 
     [bookmark: pgfId-6367637]Step 3 If prompted, enter the PIN associated with the CAC you inserted in step 1.
 
     [bookmark: pgfId-6367638]Your PIN is accepted.
 
     [bookmark: pgfId-6367639]Step 4 If prompted, select the appropriate certificate from the drop-down list.
 
     [bookmark: pgfId-6367640]The browser accepts your selection and the Login page appears.
 
     [bookmark: pgfId-6367641]Step 5 In the Username and Password fields, log in as a user with Administrator privileges. User names are case sensitive.
 
      
       
     
 
     
 
     [bookmark: pgfId-6367642]Tip You cannot log in using your CAC credentials until you have fully configured CAC authentication and authorization.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367643]The default start page appears.
 
     [bookmark: pgfId-6575175]Step 6 Navigate to System > Local > User Management and click the External Authentication tab. Create an LDAP authentication object exclusively for CAC authentication and authorization, following the procedures outlined in Preparing to Create an LDAP Authentication Object and Creating Advanced LDAP Authentication Objects. You must configure the following:
 
      
       
       	 [bookmark: pgfId-6575182]the  User Name Template in the advanced options of the  LDAP-Specific Parameters section. For more information, see Understanding User Name Templates.
 
       	 [bookmark: pgfId-6575188]the  UI Access Attribute in the  Attribute Mapping section. For more information, see Understanding Attributes to Manage Access.
 
       	 [bookmark: pgfId-6575190]the distinguished names for existing LDAP groups in the  Group Controlled Access Roles  section, if you want to preconfigure access rights through LDAP group membership. For more information, see Understanding Group Membership to Manage Access.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-6575194]Tip Note that you cannot configure both CAC authentication and shell access in the same authentication object. If you also want to authorize users for shell access, create separate authentication objects and enable them separately in your system policy.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6575195]Step 7 Click Save.
 
     [bookmark: pgfId-6575196]The External Authentication page appears, with the new object listed.
 
     [bookmark: pgfId-6589261]Step 8 Navigate to System > Local > System Policy. Enable external authentication, then CAC authentication in your system policy, following the procedure outlined in Enabling External Authentication.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-6589268] 
      Caution Your changes do 
      not take effect until you apply the system policy to the Defense Center and its managed devices. See 
      Applying a System Policy for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-6441311]Step 9 Navigate to System > Local > Configuration and click HTTPS Certificate. Import a HTTPS server certificate, if necessary, following the procedure outlined in Uploading Server Certificates. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6367647]Note The same certificate authority (CA) must issue the HTTPS server certificate and the user certificates on the CACs you plan to use for authentication and authorization.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367648]The Current HTTPS Certificate Page updates to reflect the new certificate.
 
     [bookmark: pgfId-6367649]Step 10 Under HTTPS User Certificate Settings, select Enable User Certificates. For more information, see Requiring User Certificates.
 
     [bookmark: pgfId-6367686]Step 11 Optionally, after a user logs in for the first time, navigate to System > Local > User Management to manually add or remove access rights for that user. If you do not modify the user’s rights, the user has only the rights granted by default. For more information, see Understanding User Privileges and Modifying User Privileges and Options.
 
     [bookmark: pgfId-6367693]For more information about changing a CAC user’s role after their initial login, see the following section, Managing CAC Authentication and Authorization.
 
     [bookmark: pgfId-6367697]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6367699][bookmark: 59119]Managing CAC Authentication and Authorization
 
     [bookmark: pgfId-6367701]After you configure and enable CAC authentication and authorization, users on your network can log into the web interface of an appliance using their CAC credentials. For more information, see Logging into the Appliance.
 
     [bookmark: pgfId-6448207]CAC-authenticated users are identified in the system by their electronic data interchange personal identifier (EDIPI) numbers. After users log in using their CAC credentials for the first time, you can manually add or remove access privileges for those users on the User Management page. If you did not preconfigure a user’s privileges using group-controlled access roles, the user has only the privileges granted by default in your system policy. For more information, see Understanding User Privileges, Understanding Group Membership to Manage Access, and Modifying User Privileges and Options.
 
     [bookmark: pgfId-6448201]Note that the system purges manually configured access privileges when it purges CAC-authenticated users from the User Management page after 24 hours of inactivity. The users are restored to the page after each subsequent login, but you must reconfigure any manual changes to their access privileges.
 
    
 
     
      [bookmark: pgfId-6448204][bookmark: 38442]Preparing to Create an LD[bookmark: marker-6448203]AP Authentication Object
 
     [bookmark: pgfId-6367719]License: Any
 
     [bookmark: pgfId-6367721]Before you configure a connection to your LDAP server, you should collect the information that you need to create the LDAP authentication object. For more information on specific aspects of configuration, see Understanding LDAP Authentication.
 
     [bookmark: pgfId-6367725]You need the following for any authentication object: 
 
      
      	 [bookmark: pgfId-6367726]the server name or IP address for the server where you plan to connect 
 
      	 [bookmark: pgfId-6367727]the server type of the server where you plan to connect
 
      	 [bookmark: pgfId-6367728]the user name and password for a user account with sufficient privileges to browse the LDAP tree
 
      	 [bookmark: pgfId-6367732]if there is a firewall between the appliance and the LDAP server, an entry in the firewall to allow outgoing connections 
 
      	 [bookmark: pgfId-6367733]if possible, the base distinguished name for the server directory where the user names reside
 
     
 
     [bookmark: pgfId-6367734]Note that you can use a third-party LDAP client to browse the LDAP tree and see base DN and attribute descriptions. You can also use that client to confirm that your selected user can browse the base DN you select. Ask your LDAP administrator to recommend an approved LDAP client for your LDAP server. 
 
     [bookmark: pgfId-6367735]Depending on how you plan to customize your LDAP authentication object configuration, you might also need the information in the following table.
 
     [bookmark: pgfId-6367780]
 
      
       
        
        [bookmark: pgfId-6367741]Table 61-1 Additional LDAP Configuration Information 
 
        
        
         
         	 
           
           [bookmark: pgfId-6367745]To... 
          
  
         	 
           
           [bookmark: pgfId-6367747]You need... 
          
  
        
 
         
         	[bookmark: pgfId-6367749]connect over a port other than 389
  
         	[bookmark: pgfId-6367751]the port number
  
        
 
         
         	[bookmark: pgfId-6367753]connect via an encrypted connection
  
         	[bookmark: pgfId-6367755]the certificate for the connection
  
        
 
         
         	[bookmark: pgfId-6367757]filter the users who can access your appliance based on an attribute value
  
         	[bookmark: pgfId-6367759]the attribute-value pair to filter by
  
        
 
         
         	[bookmark: pgfId-6367761]use an attribute as a UI access attribute rather than checking the user distinguished name
  
         	[bookmark: pgfId-6367763]the name of the attribute
  
        
 
         
         	[bookmark: pgfId-6367765]use an attribute as a shell login attribute rather than checking the user distinguished name
  
         	[bookmark: pgfId-6367767]the name of the attribute
  
        
 
         
         	[bookmark: pgfId-6367769]filter the users who can access your appliance via the shell based on an attribute value
  
         	[bookmark: pgfId-6367771]the attribute-value pair to filter by
  
        
 
         
         	[bookmark: pgfId-6367773]associate groups with specific user roles
  
         	[bookmark: pgfId-6367775]the distinguished name of each group, as well as the group member attribute if the groups are static groups or the group member URL attribute if the groups are dynamic groups
  
        
 
         
         	[bookmark: pgfId-6367777]use CACs for authentication and authorization
  
         	[bookmark: pgfId-6367779]your CAC, a server certificate signed by the same CA that issued your CAC, and the certificate chain for both certificates
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-6367782][bookmark: 89155]Creating Basic LDAP Authentication Objects
 
     [bookmark: pgfId-6367786]License: Any
 
     [bookmark: pgfId-6367788]You can set up an LDAP authentication object where you customize many of the values. However, if you just want to authenticate all the users in a particular directory, you can create a basic authentication object with the base DN for that directory. If you set defaults to those for your server type and supply authentication credentials for the account used to retrieve user data from the server, you can quickly create an authentication object. Follow the procedure below to do so. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6367789]Note If you prefer to consider and possibly customize each authentication setting when creating the authentication object (to configure CAC authentication and authorization, for example), use the procedure in Creating Advanced LDAP Authentication Objects to create the object. You should also use the advanced procedure if you plan to encrypt your connection to the server, set user timeouts, customize the user name template, or assign FireSIGHT System user roles based on LDAP group membership.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367796]Before you configure a connection to your LDAP server, you should collect the information that you need to create the LDAP authentication object. For more information on specific aspects of configuration, see Understanding LDAP Authentication.
 
     [bookmark: pgfId-6367800]To create a basic authentication object, you need the following: 
 
      
      	 [bookmark: pgfId-6367801]the server name or IP address for the server where you plan to connect 
 
      	 [bookmark: pgfId-6367802]the server type of the server where you plan to connect
 
      	 [bookmark: pgfId-6367803]the user name and password for a user account with sufficient privileges to browse the LDAP tree; Cisco recommends that you use a domain admin user account for this purpose
 
     
 
     [bookmark: pgfId-6367807]Optionally, if you want to constrain your user search further, you can add a base filter to set a specific value for a specific attribute. The base filter focuses your search by only retrieving objects in the base DN that have the attribute value set in the filter. Enclose the base filter in parentheses. For example, to filter for only users with a common name starting with F, use the filter (cn=F*). When you save the authentication object, the local appliance queries using the base filter to test it and indicates whether or not the filter appears to be correct.
 
     [bookmark: pgfId-6367808]To create an LDAP authentication object:
 
     [bookmark: pgfId-6367812]Access: Admin
 
     
 
     [bookmark: pgfId-6367813]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-6367814]The User Management page appears.
 
     [bookmark: pgfId-6367815]Step 2 Click the External Authentication tab.
 
     [bookmark: pgfId-6367816]The External Authentication page appears. 
 
     [bookmark: pgfId-6367817]Step 3 Click Create External Authentication Object.
 
     [bookmark: pgfId-6367818]Step 4 Select LDAP from the Authentication Method drop-down list.
 
     [bookmark: pgfId-6367819]LDAP configuration options appear.
 
     [bookmark: pgfId-6367820]Step 5 Type a name and description for the authentication server in the Name and Description fields.
 
     [bookmark: pgfId-6367821]Step 6 Select your server type from the Server Type drop-down list, then click the Set Defaults button to configure default settings for that type. You have the following options:
 
      
       
       	 [bookmark: pgfId-6367822]If you are connecting to a Microsoft Active Directory Server, select  MS Active Directory , then click  Set Defaults . 
 
       	 [bookmark: pgfId-6367823]If you are connecting to a Sun Java Systems Directory Server or Oracle Directory Server, select  Oracle Directory , then click  Set Defaults . 
 
       	 [bookmark: pgfId-6367824]If you are connecting to an OpenLDAP server, select  OpenLDAP , then click  Set Defaults .
 
       	 [bookmark: pgfId-6367825]If you are connecting to a server other than those listed above and want to clear default settings, select  Other , then click  Set Defaults . 
 
      
 
     
 
     [bookmark: pgfId-6367826]Step 7 Type the IP address or host name for the primary server where you want to obtain authentication data in the Primary Server Host Name/IP Address field.
 
      
       
     
 
     
 
     [bookmark: pgfId-6367827]Note If you are using a certificate to connect via TLS or SSL, the host name in the certificate must match the host name used in this field. In addition, IPv6 addresses are not supported for encrypted connections. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367828]Step 8 To fetch a list of all base DNs, click Fetch DNs and select the appropriate base DN from the drop-down list. 
 
     [bookmark: pgfId-6367829]For example, to authenticate names in the Security organization at the Example company, select ou=security,dc=example,dc=com.
 
     [bookmark: pgfId-6367830]Step 9 Optionally, to set a filter that retrieves only specific objects within the directory you specified as the Base DN, type the attribute type, a comparison operator, and the attribute value you want to use as a filter, enclosed in parentheses, in the Base Filter field (maximum 450 characters, including the enclosing parentheses). 
 
     [bookmark: pgfId-6367831]For example, if the user objects in a tree have a physicalDeliveryOfficeName attribute and users in the New York office have an attribute value of NewYork for that attribute, to retrieve only users in the New York office, type (physicalDeliveryOfficeName=NewYork).
 
     [bookmark: pgfId-6367832]Step 10 In the User Name and Password fields, type the distinguished name and password for a user who has sufficient credentials to browse the LDAP server.
 
     [bookmark: pgfId-6367834]For example, if you are connecting to an [bookmark: marker-6367833]OpenLDAP server where user objects have a uid attribute and the object for the administrator in the Security division at our example company has a uid value of NetworkAdmin, you might type uid=NetworkAdmin,ou=security,dc=example,dc=com.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-6367835] 
      Caution If you are connecting to a Microsoft Active Directory Server, you cannot provide a server user name that ends with the 
      $ character. 
       
       
 
      
 
     
 
     [bookmark: pgfId-6367836]Step 11 Retype the password in the Confirm Password field.
 
     [bookmark: pgfId-6367837]Step 12 Optionally, to retrieve users for shell access, type the attribute type you want to filter on in the Shell Access Attribute field.
 
     [bookmark: pgfId-6367838]For example, on a Microsoft Active Directory Server, use the sAMAccountName shell access attribute to retrieve shell access users by typing sAMAccountName in the Shell Access Attribute field.
 
      
       
     
 
     
 
     [bookmark: pgfId-6367839]Note IPv6 addresses are not supported for shell authentication.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367840]Step 13 In the User Name and Password fields, type the uid value or shell access attribute value and password for the user whose credentials should be used to validate access to the LDAP server. Note, again, that server user names associated with a Microsoft Active Directory Server cannot end with the character $.
 
     [bookmark: pgfId-6367841]For example, to test to see if you can retrieve the JSmith user credentials at the Example company, type JSmith.
 
     [bookmark: pgfId-6367842]Step 14 Click Test to test the connection. 
 
     [bookmark: pgfId-6367843]A message appears, either indicating success of the test or detailing what settings are missing or need to be corrected. If the test succeeds, the test output appears at the bottom of the page, including a list of the users retrieved by the connection. If the number of users that appear in the test output is limited by the number of user records your LDAP server returns, the test output indicates this limitation.
 
     [bookmark: pgfId-6367844]Step 15 You have two options: 
 
      
       
       	 [bookmark: pgfId-6367845]If the test succeeds, click  Save .
 
      
 
     
 
     [bookmark: pgfId-6367846]The External Authentication page appears, with the new object listed.
 
     [bookmark: pgfId-6367847]To enable LDAP authentication using the object on an appliance, you must apply a system policy with that object enabled to the appliance. For more information, see Enabling External Authentication and Applying a System Policy. 
 
      
       
       	 [bookmark: pgfId-6367854]If the test fails, or if you want to refine the list of users retrieved, continue with the next section, Tuning Your Basic LDAP Authentication Connection.
 
      
 
     
 
     [bookmark: pgfId-6367858]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6367860][bookmark: 64230]Tuning Your Basic LDAP Authentication Connection
 
     [bookmark: pgfId-6367864]License: Any
 
     [bookmark: pgfId-6367866]If you create an LDAP authentication object and it either does not succeed in connecting to the server you select, or does not retrieve the list of users you want, you can tune the settings in the object.
 
     [bookmark: pgfId-6367867]If the connection fails when you test it, try the following suggestions to troubleshoot your configuration:
 
      
      	 [bookmark: pgfId-6367868]Use the messages displayed at the top of the screen and in the test output to determine which areas of the object are causing the issue.
 
      	 [bookmark: pgfId-6367869]Check that the user name and password you used for the object are valid:
 
       
       	 [bookmark: pgfId-6367870]Check that the user has the rights to browse to the directory indicated in your base distinguished name by connecting to the LDAP server using a third-party LDAP browser. 
 
       	 [bookmark: pgfId-6367871]Check that the user name is unique to the directory information tree for the LDAP server.
 
       	 [bookmark: pgfId-6367872]Check that the user name contains only underscores, periods, hyphens, and alphanumeric characters.
 
       	 [bookmark: pgfId-6367873]If you see an LDAP bind error 49 in the test output, the user binding for the user failed. Try authenticating to the server through a third-party application to see if the binding fails through that connection as well.
 
      
 
      	 [bookmark: pgfId-6367874]Check that you have correctly identified the server: 
 
       
       	 [bookmark: pgfId-6367875]Check that the server IP address or host name is correct. 
 
       	 [bookmark: pgfId-6367876]Check that you have TCP/IP access from your local appliance to the authentication server where you want to connect.
 
       	 [bookmark: pgfId-6367877]Check that access to the server is not blocked by a firewall and that the port you have configured in the object is open.
 
       	 [bookmark: pgfId-6367878]If you are using a certificate to connect via TLS or SSL, the host name in the certificate must match the host name used for the server. 
 
       	 [bookmark: pgfId-6367879]Check that you have not used an IPv6 address for the server connection if you are authenticating shell access.
 
       	 [bookmark: pgfId-6367880]If you used server type defaults, check that you have the correct server type and click  Set Defaults again to reset the default values.
 
      
 
     
 
     [bookmark: pgfId-6367884]For more information, see Identifying the LDAP Authentication Server.
 
      
      	 [bookmark: pgfId-6367885]If you typed in your base distinguished name, click  Fetch DNs to retrieve all the available base distinguished names on the server, and select the name from the list.
 
      	 [bookmark: pgfId-6367886]If you are using any filters, access attributes, or advanced settings, check that each is valid and typed correctly.
 
      	 [bookmark: pgfId-6367887]If you are using any filters, access attributes, or advanced settings, try removing each setting and testing the object without it.
 
      	 [bookmark: pgfId-6367888]If you are using a base filter or a shell access filter, make sure that the filter is enclosed in parentheses and that you are using a valid comparison operator. For more information, see Understanding Base Filters and Understanding Shell Access.
 
      	 [bookmark: pgfId-6367895]To test a more restricted base filter, try setting it to the base distinguished name for the user to retrieve just that user.
 
      	 [bookmark: pgfId-6367896]If you are using an encrypted connection: 
 
       
       	 [bookmark: pgfId-6367897]Check that the name of the LDAP server in the certificate matches the host name that you use to connect.
 
       	 [bookmark: pgfId-6367898]Check that you have not used an IPv6 address with an encrypted server connection.
 
      
 
      	 [bookmark: pgfId-6367899]If you are using a test user, make sure that the user name and password are typed correctly. 
 
      	 [bookmark: pgfId-6367900]If you are using a test user, remove the user credentials and test the object.
 
      	 [bookmark: pgfId-6367901]Test the query you are using by connecting to the LDAP server via the command line on the appliance you want to connect from using this syntax:
 
     
 
      
      [bookmark: pgfId-6367902]ldapsearch -x -b 'base_distinguished_name'
-h LDAPserver_ip_address -p port -v -D 
'user_distinguished_name' -W 'base_filter' 
     
 
     [bookmark: pgfId-6367903]For example, if you are trying to connect to the security domain on myrtle.example.com using the domainadmin@myrtle.example.com user and a base filter of (cn=*), you could test the connection using this statement:
 
      
      [bookmark: pgfId-6367904]ldapsearch -x -b 'CN=security,DC=myrtle,DC=example,DC=com'
-h myrtle.example.com -p 389 -v -D 
'domainadmin@myrtle.example.com' -W '(cn=*)' 
     
 
     [bookmark: pgfId-6367905]If you can test your connection successfully but authentication does not work after you apply a system policy, check that authentication and the object you want to use are both enabled in the system policy that is applied to the appliance.
 
     [bookmark: pgfId-6367906]If you connect successfully but want to adjust the list of users retrieved by your connection, you can add or change a base filter or shell access filter or use a more restrictive or less restrictive base DN. For more information, see the following topics:
 
      
      	 [bookmark: pgfId-6367910]Understanding Base DNs
 
      	 [bookmark: pgfId-6367914]Understanding Base Filters
 
      	 [bookmark: pgfId-6367918]Configuring LDAP-Specific Parameters
 
     
 
    
 
     
      [bookmark: pgfId-6367921][bookmark: 90805]Creating Advanced LDAP Authentication[bookmark: marker-6367920] Objects
 
     [bookmark: pgfId-6367925]License: Any
 
     [bookmark: pgfId-6367927]You can create LDAP authentication objects to provide user authentication services for an appliance. 
 
     [bookmark: pgfId-6367928]When you create an authentication object, you define settings that let you connect to an authentication server. You also select the directory context and search criteria you want to use to retrieve user data from the server. Optionally, you can configure shell access authentication. 
 
     [bookmark: pgfId-6367929]Make sure you have TCP/IP access from your local appliance to the authentication server where you want to connect.
 
     [bookmark: pgfId-6367930]Although you can use the default settings for your server type to quickly set up a basic LDAP configuration, you can also customize advanced settings to control whether the appliance makes an encrypted connection to the LDAP server, the timeout for the connection, and which attributes the server checks for user information. 
 
     [bookmark: pgfId-6367931]For the LDAP-specific parameters, you can use LDAP naming standards and filter and attribute syntax. For more information, see the RFCs listed in the Lightweight Directory Access Protocol (v3): Technical Specification, RFC 3377. Examples of syntax are provided throughout this procedure. Note that when you set up an authentication object to connect to a Microsoft Active Directory Server, you can use the address specification syntax documented in the Internet RFC 822 (Standard for the Format of ARPA Internet Text Messages) specification when referencing a user name that contains a domain. For example, to refer to a user object, you might type JoeSmith@security.example.com rather than the equivalent user distinguished name of cn=JoeSmith,ou=security, dc=example,dc=com when using Microsoft Active Directory Server.
 
      
       
     
 
     
 
     [bookmark: pgfId-6367932]Note If you are configuring an LDAP authentication object for use with CAC authentication, do not remove the CAC inserted in your computer. You must have a CAC inserted at all times after enabling user certificates. For more information, see Requiring User Certificates and Understanding LDAP Authentication With CAC.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367939]To create an advanced authentication object:
 
     [bookmark: pgfId-6367943]Access: Admin
 
     
 
     [bookmark: pgfId-6367944]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-6367945]The User Management page appears.
 
     [bookmark: pgfId-6367946]Step 2 Click the External Authentication tab.
 
     [bookmark: pgfId-6367947]The External Authentication page appears. 
 
     [bookmark: pgfId-6367948]Step 3 Click Create External Authentication Object.
 
     [bookmark: pgfId-6367949]The Create External Authentication Object page appears. 
 
     [bookmark: pgfId-6367950]Step 4 Identify the authentication server where you want to retrieve user data for external authentication. For more information, see Identifying the LDAP Authentication Server.
 
     [bookmark: pgfId-6367954]Step 5 Configure authentication settings to build a search request that retrieves the users you want to authenticate. Specify a user name template to format the user names that users enter on login. For more information, see Configuring LDAP-Specific Parameters.
 
     [bookmark: pgfId-6367958]Step 6 Optionally, configure LDAP groups to use as the basis for default access role assignments. For more information, see Configuring Access Rights by Group.
 
      
       
     
 
     
 
     [bookmark: pgfId-6367965]Tip If you plan to use this object for CAC authentication and authorization, Cisco recommends configuring LDAP groups to manage access role assignments. For more information, see Managing CAC Authentication and Authorization.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6367969]Step 7 Optionally, configure authentication settings for shell access. For more information, see Configuring Shell Access.
 
     [bookmark: pgfId-6367973]Step 8 Test your configuration by entering the name and password for a user who can successfully authenticate. For more information, see Testing User Authentication.
 
     [bookmark: pgfId-6367977]Your changes are saved. Remember that you must apply a system policy with the object enabled to an appliance before the authentication changes take place on that appliance. For more information, see Enabling External Authentication and Applying a System Policy.
 
     [bookmark: pgfId-6367984]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6367987][bookmark: 97267]Identifying the LDAP Authenti[bookmark: marker-6367986]cation Server
 
     [bookmark: pgfId-6367991]License: Any
 
     [bookmark: pgfId-6367993]When you create an authentication object, you first specify the primary and backup server and server port where you want the managed device or Defense Center to connect for authentication.
 
     [bookmark: pgfId-6367997]To identify an LDAP authentication server:
 
     [bookmark: pgfId-6368001]Access: Admin
 
     
 
     [bookmark: pgfId-6368002]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-6368003]The User Management page appears.
 
     [bookmark: pgfId-6368004]Step 2 Click the External Authentication tab.
 
     [bookmark: pgfId-6368005]The External Authentication page appears. 
 
     [bookmark: pgfId-6368006]Step 3 Click Create External Authentication Object.
 
     [bookmark: pgfId-6368007]The Create External Authentication Object page appears.
 
     [bookmark: pgfId-6368008]Step 4 Select LDAP from the Authentication Method drop-down list.
 
     [bookmark: pgfId-6368009]LDAP configuration options appear.
 
     [bookmark: pgfId-6368010]Step 5 Optionally, select the check box for CAC if you plan to use this authentication object for CAC authentication and authorization. 
 
     [bookmark: pgfId-6368013]For an overview of configuring CAC authentication and authorization, see Understanding LDAP Authentication With CAC.
 
     [bookmark: pgfId-6368015]Step 6 Type a name and description for the authentication server in the Name and Description fields.
 
     [bookmark: pgfId-6368016]Step 7 Optionally, in the Server Type field, select the type of LDAP server you plan to connect to and click Set Defaults to populate the User Name Template, UI Access Attribute, Shell Access Attribute, Group Member Attribute, and Group Member URL Attribute fields with default values. You have the following options:
 
      
       
       	 [bookmark: pgfId-6368017]If you are connecting to a Microsoft Active Directory server, select  MS Active Directory and click  Set Defaults .
 
       	 [bookmark: pgfId-6368018]If you are connecting to a Sun Java Systems Directory Server or Oracle Directory Server, select  Oracle Directory and click  Set Defaults . 
 
       	 [bookmark: pgfId-6368019]If you are connecting to an OpenLDAP server, select  OpenLDAP and click  Set Defaults . 
 
       	 [bookmark: pgfId-6368020]If you are connecting to a LDAP server other than those listed above and want to clear default settings, select  Other and click  Set Defaults . 
 
      
 
     
 
     [bookmark: pgfId-6368021]Step 8 Type the IP address or host name for the primary server where you want to obtain authentication data in the Primary Server Host Name/IP Address field.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368022]Note If you are using a certificate to connect via TLS or SSL, the host name in the certificate must match the host name used in this field. In addition, IPv6 addresses are not supported for encrypted connections. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368023]Step 9 Optionally, modify the port used by the primary authentication server in the Primary Server Port field.
 
     [bookmark: pgfId-6368024]Step 10 Optionally, type the IP address or host name for the backup server where you want to obtain authentication data in the Backup Server Host Name/IP Address field.
 
     [bookmark: pgfId-6368025]Step 11 Optionally, modify the port used by the primary authentication server in the Backup Server Port field.
 
     [bookmark: pgfId-6368029]Continue with Configuring LDAP-Specific Parameters.
 
     [bookmark: pgfId-6368030]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368032][bookmark: 98915]Configuring LDAP-Specific Parameters
 
     [bookmark: pgfId-6368036]License: Any
 
     [bookmark: pgfId-6368038]The settings in the LDAP-specific parameters section determine the area of the LDAP directory where the appliance searches for user names, and control details of how the appliance connects to the LDAP server.
 
     [bookmark: pgfId-6368039]When configuring these settings, note that valid user names are unique, and can include underscores (_), periods (.), and hyphens (-), but otherwise only alphanumeric characters are supported. 
 
     [bookmark: pgfId-6368040]In addition for most LDAP-specific settings, you can use LDAP naming standards and filter and attribute syntax. For more information, see the RFCs listed in the Lightweight Directory Access Protocol (v3): Technical Specification, RFC 3377. Examples of syntax are provided throughout this procedure. Note that when you set up an authentication object to connect to a Microsoft Active Directory Server, you can use the address specification syntax documented in the Internet RFC 822 (Standard for the Format of ARPA Internet Text Messages) specification when referencing a user name that contains a domain. For example, to refer to a user object, you might type JoeSmith@security.example.com rather than the equivalent user distinguished name of cn=JoeSmith,ou=security, dc=example,dc=com when using Microsoft Active Directory Server.
 
      
       
        
        [bookmark: pgfId-6368047]Table 61-2 LDAP-Specific Parameters 
 
        
        
         
         	 
           
           [bookmark: pgfId-6368053]Setting 
          
  
         	 
           
           [bookmark: pgfId-6368055]Description 
          
  
         	 
           
           [bookmark: pgfId-6368057]Examples 
          
  
        
 
         
         	[bookmark: pgfId-6368059]Base DN
  
         	[bookmark: pgfId-6368061]Supplies the base distinguished name of the directory where the appliance searches for user information on the LDAP server.
 [bookmark: pgfId-6368062]Typically, the base DN has a basic structure indicating the company domain and operational unit. 
 [bookmark: pgfId-6368063]Note that after you identify a primary server, you can automatically retrieve a list of available base DNs from the server and select the appropriate base DN.
  
         	[bookmark: pgfId-6368065]The Security organization of the Example company might have a base DN of ou=security, dc=example,dc=com
  
        
 
         
         	[bookmark: pgfId-6368067]Base Filter
  
         	[bookmark: pgfId-6368069]Focuses your search by only retrieving objects in the base DN that have the specific attribute-value pair set in the filter. Note that you must enclose the base filter in parentheses.
 [bookmark: pgfId-6368070]To test your base filter more specifically by entering a test user name and password, see Testing User Authentication.
  
         	[bookmark: pgfId-6368075]To filter for only users with a common name starting with F, use the filter (cn=F*). 
  
        
 
         
         	[bookmark: pgfId-6368077]User Name/ Password
  
         	[bookmark: pgfId-6368079]Allow the local appliance to access the user objects. Supply user credentials for a user with appropriate rights to the authentication objects you want to retrieve. The distinguished name for the user you specify must be unique to the directory information tree for the LDAP server. Note that server user names associated with a Microsoft Active Directory Server cannot end with the $ character.
  
         	[bookmark: pgfId-6368081]The user name for the admin user in the Security organization of the Example company might have a user name of cn=admin,
ou=security,
dc=example,dc=com
  
        
 
         
         	[bookmark: pgfId-6368083]Encryption
  
         	[bookmark: pgfId-6368085]Determines whether and how the communications are encrypted. You can choose no encryption, Transport Layer Security (TLS), or Secure Sockets Layer (SSL) encryption. Note that if you are using a certificate to authenticate when connecting via TLS or SSL, the name of the LDAP server in the certificate must match the name that you use to connect. 
 [bookmark: pgfId-6368086]If you change the encryption method after specifying the port, the port resets to the default value for the selected server type. 
  
         	[bookmark: pgfId-6368088]If you enter 10.10.10.250 in the external authentication settings and computer1.
example.com in the certificate, the connection fails, even if computer1.
example.com has an IP address of 10.10.10.250. Changing the name of the server in the external authentication settings to computer1.
example.com causes the connection to succeed. 
  
        
 
         
         	[bookmark: pgfId-6368090]SSL Certificate Upload Path
  
         	[bookmark: pgfId-6368092]Indicates the path on your local computer to the certificate to be used for encryption.
  
         	[bookmark: pgfId-6368094]c:/server.crt
  
        
 
         
         	[bookmark: pgfId-6368096]User Name Template
  
         	[bookmark: pgfId-6368098]Indicates how user names entered on login should be formatted, by mapping the string conversion character (%s) to the value of the shell access attribute for the user. The user name template is the format for the distinguished name used for authentication. When a user enters a user name into the login page, the appliance substitutes the name for the string conversion character and uses the resulting distinguished name to search for the user credentials.
 [bookmark: pgfId-6368099]If you want to use this object for CAC authentication and authorization, you must enter a value that corresponds with your UI Access Attribute value. For more information, see Understanding LDAP Authentication With CAC.
  
         	[bookmark: pgfId-6368104]%s@security.example.com,
 [bookmark: pgfId-6578694]%s@mail.com, 
 [bookmark: pgfId-6578691]%s@mil,
 [bookmark: pgfId-6578697]%s@smil.mil,
  
        
 
         
         	[bookmark: pgfId-6368107]Timeout
  
         	[bookmark: pgfId-6368109]Sets a timeout for the connection attempt to the primary server, so the connection rolls over to the backup server. If the number of seconds indicated in this field (or the timeout on the LDAP server) elapses without a response from the primary authentication server, the appliance then queries the backup server. 
 [bookmark: pgfId-6368110]However, if LDAP is running on the port of the primary LDAP server and for some reason refuses to service the request, the failover to the backup server does not occur. 
  
         	[bookmark: pgfId-6368112]If the primary server has LDAP disabled, the appliance queries the backup server. 
  
        
 
         
         	[bookmark: pgfId-6368114]UI Access Attribute
  
         	[bookmark: pgfId-6368116]Tells the local appliance to match the value of a specific attribute rather than the value of the user distinguished name. You can use any attribute, if the value of the attribute is a valid user name for the FireSIGHT System web interface. If one of the objects has a matching user name and password, the user login request is authenticated.
 [bookmark: pgfId-6368120]Selecting a server type and setting defaults prepopulates the UI Access Attribute with a value typically appropriate for that type of server. 
 [bookmark: pgfId-6368121]If you leave this field blank, the local appliance checks the user distinguished name value for each user record on the LDAP server to see if it matches the user name.
 [bookmark: pgfId-6368122]If you want to use this object for CAC authentication and authorization, you must enter a value that corresponds with your User Name Template value. For more information, see Understanding LDAP Authentication With CAC.
  
         	[bookmark: pgfId-6368127]sAMAccountName,
 [bookmark: pgfId-6571617]userPrincipalName,
 [bookmark: pgfId-6571620]mail
  
        
 
         
         	[bookmark: pgfId-6368129]Shell Access Attribute
  
         	[bookmark: pgfId-6368131]If you want to check a specific attribute for shell access credentials, you must explicitly set this field to match the attribute. You can use any attribute if the value of the attribute is a valid user name for shell access.
 [bookmark: pgfId-6368132]If you leave this field blank, the user distinguished name is used for shell access authentication.
 [bookmark: pgfId-6368133]Note that selecting a server type and setting defaults prepopulates this field with an attribute typically appropriate for that type of server. 
  
         	[bookmark: pgfId-6368135]sAMAccountName
  
        
 
        
      
 
     
 
     [bookmark: pgfId-6368137]To configure the LDAP-specific parameters for a server:
 
     [bookmark: pgfId-6368141]Access: Admin
 
     
 
     [bookmark: pgfId-6368142]Step 1 In the LDAP-Specific Parameters section of the Create External Authentication Object page, you have two options for setting the base DN:
 
      
       
       	 [bookmark: pgfId-6368143]To fetch a list of all available domains, click  Fetch DNs and select the appropriate base domain name from the drop-down list. 
 
       	 [bookmark: pgfId-6368144]Type the base distinguished name for the LDAP directory you want to access in the  Base DN field.
 
      
 
     
 
     [bookmark: pgfId-6368145]For example, to authenticate names in the Security organization at the Example company, type or select ou=security,dc=example,dc=com.
 
     [bookmark: pgfId-6368146]Step 2 Optionally, to set a filter that retrieves only specific objects within the directory you specified as the Base DN, type the attribute type, a comparison operator, and the attribute value you want to use as a filter, enclosed in parentheses, in the Base Filter field. 
 
     [bookmark: pgfId-6368147]For example, if the user objects in a directory tree have a physicalDeliveryOfficeName attribute and users in the New York office have an attribute value of NewYork for that attribute, to retrieve only users in the New York office, type (physicalDeliveryOfficeName=NewYork).
 
     [bookmark: pgfId-6368148]Step 3 Type the distinguished name and password for the user whose credentials should be used to validate access to the LDAP directory in the User Name and Password fields.
 
     [bookmark: pgfId-6368150]For example, if you are connecting to an [bookmark: marker-6368149]OpenLDAP server where user objects have a uid attribute and the object for the administrator in the Security division at our example company has a uid value of NetworkAdmin, you might type uid=NetworkAdmin,ou=security,dc=example,dc=com.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-6368151] 
      Caution If you are connecting to a Microsoft Active Directory Server, you cannot provide a server user name that ends with the 
      $ character. 
       
       
 
      
 
     
 
     [bookmark: pgfId-6368152]Step 4 Retype the password in the Confirm Password field.
 
     [bookmark: pgfId-6368153]Step 5 After you configure the basic LDAP-specific parameters, you have several options:
 
      
       
       	 [bookmark: pgfId-6368154]To access advanced options, click the arrow next to  Show Advanced Options and continue with the next step. 
 
       	 [bookmark: pgfId-6368155]If you want to configure user default roles based on LDAP group membership, continue with Configuring Access Rights by Group.
 
       	 [bookmark: pgfId-6368161]If you are not using LDAP groups for authentication, continue with Configuring Shell Access.
 
      
 
     
 
     [bookmark: pgfId-6368163]Step 6 Optionally, select one of the following encryption modes:
 
      
       
       	 [bookmark: pgfId-6368164]To connect using Secure Sockets Layer (SSL), select  SSL .
 
       	 [bookmark: pgfId-6368165]To connect using Transport Layer Security (TLS), select  TLS .
 
       	 [bookmark: pgfId-6368166]To connect without encryption, select  None .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-6368167]Note Note that if you change the encryption method after specifying a port, you reset the port to the default value for that method. For none or TLS, the port uses the default value of 389. If you select SSL encryption, the port uses the default of 636.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368168]Step 7 If you selected TLS or SSL encryption and you want to use a certificate to authenticate, click Browse to browse to the location of a valid TLS or SSL certificate or, in the SSL Certificate Upload Path field, type the path to the certificate.
 
     [bookmark: pgfId-6368169]A message appears, indicating a successful certificate upload.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368170]Note If you previously uploaded a certificate and want to replace it, upload the new certificate and reapply the system policy to your appliances to copy over the new certificate.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368171]Step 8 Optionally, in the User Name Template field, type the string conversion character (%s) used to determine the user name from the value found in the UI Access Attribute. 
 
     [bookmark: pgfId-6368172]For example, to authenticate all users who work in the Security organization of our example company by connecting to an OpenLDAP server where the shell access attribute is uid, you might type uid=%s,ou=security,dc=example,dc=com in the User Name Template field. For a Microsoft Active Directory server, you could type %s@security.example.com.
 
     [bookmark: pgfId-6368173]If you want to use CAC credentials for authentication and authorization, you must enter a value in the User Name Template field. For more information, see Understanding LDAP Authentication With CAC.
 
     [bookmark: pgfId-6368177]Step 9 Optionally, in the Timeout field, type the number of seconds that should elapse before rolling over to the backup connection.
 
     [bookmark: pgfId-6368178]Step 10 Optionally, to retrieve users based on an attribute instead of the Base DN and Base Filter, you have two options:
 
      
       
       	 [bookmark: pgfId-6368179]Click  Fetch Attrs to retrieve a list of available attributes and select the appropriate attribute. 
 
       	 [bookmark: pgfId-6368180]Type the attribute in the  UI Access Attribute field.
 
      
 
     
 
     [bookmark: pgfId-6368181]For example, on a Microsoft Active Directory Server, you may want to use the UI Access Attribute to retrieve users, because there may not be a uid attribute on Active Directory Server user objects. Instead, you can search the userPrincipalName attribute by typing userPrincipalName in the UI Access Attribute field.
 
     [bookmark: pgfId-6368182]If you want to use CAC credentials for authentication and authorization, you must enter a value in the UI Access Attribute field. For more information, see Understanding LDAP Authentication With CAC.
 
     [bookmark: pgfId-6368186]Step 11 Optionally, to retrieve users for shell access, type the attribute to filter by in the Shell Access Attribute field.
 
     [bookmark: pgfId-6368187]For example, on a Microsoft Active Directory Server, use the sAMAccountName shell access attribute to retrieve shell access users by typing sAMAccountName in the Shell Access Attribute field.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368188]Note You cannot configure CAC authentication and authorization and shell access in the same authentication object. Selecting the CAC check box disables the shell access configuration options on the page. Instead, create separate authentication objects and enable them separately in your system policy. For more information, see Enabling External Authentication.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368192]Step 12 For the next step, you have three choices:
 
      
       
       	 [bookmark: pgfId-6368193]If you want to configure user default roles based on LDAP group membership, continue with Configuring Access Rights by Group.
 
       	 [bookmark: pgfId-6368197]If you are  not using LDAP groups for authentication but you want to configure shell access, continue with Configuring Shell Access.
 
       	 [bookmark: pgfId-6368201]If you are  not using LDAP groups for authentication and you do  not want to configure shell access, continue with Testing User Authentication.
 
      
 
     
 
     [bookmark: pgfId-6368205]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368208][bookmark: 48894]Configuring Access Rights[bookmark: marker-6368207] by Group
 
     [bookmark: pgfId-6368212]License: Any
 
     [bookmark: pgfId-6368214]If you prefer to base default access rights on a user’s membership in an LDAP group, you can specify distinguished names for existing groups on your LDAP server for each of the access roles used by your FireSIGHT System. When you do so, you can configure a default access setting for those users detected by LDAP that do not belong to any specified groups. When a user logs in, the FireSIGHT System dynamically checks the LDAP server and assigns default access rights according to the user’s current group membership.
 
     [bookmark: pgfId-6368224]If you plan to use an object for CAC authentication and authorization, Cisco recommends configuring LDAP groups to manage access role assignments for CAC-authenticated users. For more information, see Managing CAC Authentication and Authorization.
 
     [bookmark: pgfId-6368228]Any group you reference must exist on the LDAP server. You can reference static LDAP groups or dynamic LDAP groups. Static LDAP groups are groups where membership is determined by group object attributes that point to specific users, and dynamic LDAP groups are groups where membership is determined by creating an LDAP search that retrieves group users based on user object attributes. Group access rights for a role only affect users who are members of the group.
 
     [bookmark: pgfId-6368232]The access rights granted when a user logs into the FireSIGHT System depend on the LDAP configuration: 
 
      
      	 [bookmark: pgfId-6368233]If no group access rights are configured for your LDAP server, when a new user logs in, the FireSIGHT System authenticates the user against the LDAP server and then grants user rights based on the default minimum access role set in the system policy. 
 
      	 [bookmark: pgfId-6368237]If you configure any group settings, new users belonging to specified groups inherit the minimum access setting for the groups where they are members. 
 
      	 [bookmark: pgfId-6368238]If a new user does not belong to any specified groups, the user is assigned the default minimum access role specified in the Group Controlled Access Roles section of the authentication object. 
 
      	 [bookmark: pgfId-6368239]If a user belongs to more than one configured group, the user receives the access role for the group with the highest access as a minimum access role.
 
     
 
     [bookmark: pgfId-6368243]You cannot use the FireSIGHT System user management page to remove the minimum access rights for users assigned an access role because of LDAP group membership. You can, however, assign additional rights. When you modify the access rights for an externally authenticated user, the Authentication Method column on the User Management page provides a status of External - Locally Modified.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368245]Note If you use a dynamic group, the LDAP query is used exactly as it is configured on the LDAP server. For this reason, the FireSIGHT System limits the number of recursions of a search to four to prevent search syntax errors from causing infinite loops. If a user’s group membership is not established in those recursions, the default access role defined in the Group Controlled Access Roles section is granted to the user.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368249]To configure default roles based on group membership:
 
     [bookmark: pgfId-6368253]Access: Admin
 
     
 
     [bookmark: pgfId-6368254]Step 1 On the Create External Authentication Object page, click the down arrow next to Group Controlled Access Roles.
 
     [bookmark: pgfId-6368255]The section expands.
 
     [bookmark: pgfId-6368256]Step 2 Optionally, configure access defaults by group membership.
 
     [bookmark: pgfId-6368260]In the DN fields that correspond to FireSIGHT System user roles, type the distinguished name for the LDAP groups that contain users who should be assigned to those roles.
 
     [bookmark: pgfId-6368261]For example, you might type the following in the Administrator field to authenticate names in the information technology organization at the Example company:
 
      
      [bookmark: pgfId-6368262]cn=itgroup,ou=groups, dc=example,dc=com 
     
 
     [bookmark: pgfId-6368266]For more information on user access roles, see Adding New User Accounts.
 
     [bookmark: pgfId-6368267]Step 3 From the Default User Role list, select the default minimum access role for users that do not belong to any of the specified groups. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6368268]Tip Press the Ctrl key while clicking role names to select multiple roles. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368269]Step 4 If you used static groups, in the Group Member Attribute field, type the LDAP attribute that designates membership in a static group. 
 
     [bookmark: pgfId-6368270]For example, if the member attribute is used to indicate membership in the static group you reference for default Security Analyst access, type member.
 
     [bookmark: pgfId-6368271]Step 5 If you used dynamic groups, in the Group Member URL Attribute field, type the LDAP attribute that contains the LDAP search string used to determine membership in a dynamic group. 
 
     [bookmark: pgfId-6368272]For example, if the memberURL attribute contains the LDAP search that retrieves members for the dynamic group you specified for default Admin access, type memberURL.
 
     [bookmark: pgfId-6368276]Step 6 Continue with Configuring Shell Access.
 
     [bookmark: pgfId-6368277]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368280][bookmark: 51426]Configuring [bookmark: marker-6368279]Shell Access
 
     [bookmark: pgfId-6368284]License: Any
 
     [bookmark: pgfId-6368286]You can also use the LDAP server to authenticate accounts for shell access on your managed device or Defense Center. Specify a search filter that retrieves entries for users you want to grant shell access. 
 
     [bookmark: pgfId-6368290]You cannot configure CAC authentication and authorization and shell access in the same authentication object. Instead, create separate authentication objects and enable them separately in your system policy. The authentication object for shell access must be the first authentication object in your system policy. For more information on managing authentication object order, see Enabling External Authentication.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368299]Note Cisco does not support external authentication for virtual devices or Cisco NGIPS for Blue Coat X-Series. In addition, IPv6 is not supported for shell access authentication.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368301]With the exception of the admin account, shell access is controlled entirely though the shell access attribute you set. The shell access filter you set determines which set of users on the LDAP server can log into the shell. 
 
     [bookmark: pgfId-6368302]Note that a home directory for each shell user is created on login, and when an LDAP shell access user account is disabled (by disabling the LDAP connection), the directory remains, but the user shell is set to /bin/false in /etc/password to disable the shell. If the user then is re-enabled, the shell is reset, using the same home directory. 
 
     [bookmark: pgfId-6368303]The Same as Base Filter check box allows you to search more efficiently if all users qualified in the base DN are also qualified for shell access privileges. Normally, the LDAP query to retrieve users combines the base filter with the shell access filter. If the shell access filter was the same as the base filter, the same query runs twice, which is unnecessarily time-consuming. You can use the Same as Base Filter option to run the query only once for both purposes.
 
     [bookmark: pgfId-6368304]Shell users can log in using user names with lowercase letters. Login authentication for the shell is case sensitive.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-6368311] 
      Caution On Series 3 Defense Centers, all shell users have 
      sudoers privileges. Make sure that you restrict the list of users with shell access appropriately. On Series 3 and virtual devices, shell access granted to externally authenticated users defaults to the 
      Configuration level of command line access, which also grants 
      sudoers privileges. 
       
       
 
      
 
     
 
     [bookmark: pgfId-6368315]To configure shell account authentication:
 
     [bookmark: pgfId-6368319]Access: Admin
 
     
 
     [bookmark: pgfId-6368320]Step 1 Optionally, on the Create External Authentication Object page, set a shell access account filter. You have multiple options:
 
      
       
       	 [bookmark: pgfId-6368321]To retrieve administrative user entries based on attribute value, type the attribute name, a comparison operator, and the attribute value you want to use as a filter, enclosed in parentheses, in the  Shell Access Filter field. 
 
       	 [bookmark: pgfId-6368322]To use the same filter you specified when configuring authentication settings, select  Same as Base Filter .
 
       	 [bookmark: pgfId-6368323]To prevent LDAP authentication of shell access, leave the field blank. If you choose not to specify a shell access filter, a warning displays when you save the authentication object to confirm that you meant to leave the filter blank.
 
      
 
     
 
     [bookmark: pgfId-6368324]For example, if all network administrators have a manager attribute which has an attribute value of shell, you can set a base filter of (manager=shell).
 
     [bookmark: pgfId-6368328]Step 2 Continue with Testing User Authentication.
 
     [bookmark: pgfId-6368329]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368332][bookmark: 85108]Testing User Auth[bookmark: marker-6368331]entication
 
     [bookmark: pgfId-6368336]License: Any
 
     [bookmark: pgfId-6368338]After you configure LDAP server and authentication settings, you can specify user credentials for a user who should be able to authenticate to test those settings.
 
     [bookmark: pgfId-6368339]For the user name, you can enter the value for the uid attribute for the user you want to test with. If you are connecting to a Microsoft Active Directory Server and supplied a shell access attribute in place of uid, use the value for that attribute as the user name. You can also specify a fully qualified distinguished name for the user.
 
     [bookmark: pgfId-6368340]The test output lists valid and invalid user names. Valid user names are unique, and can include underscores (_), periods (.), and hyphens (-), but otherwise only alphanumeric characters are supported. Invalid user names are user names containing other non-alphanumeric characters, such as spaces.
 
     [bookmark: pgfId-6368341]Note that testing the connection to servers with more than 1000 users only returns 1000 users because of web interface page size limitations. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6368342]Tip If you mistype the name or password of the test user, the test fails even if the server configuration is correct. Test the server configuration without the additional test parameters first. If that succeeds supply a user name and password to test with the specific user. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368343]To test user authentication:
 
     [bookmark: pgfId-6368347]Access: Admin
 
     
 
     [bookmark: pgfId-6368348]Step 1 In the User Name and Password fields, type the uid value or shell access attribute value and password for the user whose credentials should be used to validate access to the LDAP server.
 
     [bookmark: pgfId-6368349]For example, to test to see if you can retrieve the JSmith user credentials at the Example company, type JSmith.
 
     [bookmark: pgfId-6368350]Step 2 Click Test.
 
     [bookmark: pgfId-6368351]A message appears, either indicating success of the test or detailing what settings are missing or need to be corrected. You have two options:
 
      
       
       	 [bookmark: pgfId-6368352]If the test succeeds, the test output appears at the bottom of the page. Click  Save . The External Authentication page appears, with the new object listed.
 
      
 
     
 
     [bookmark: pgfId-6368353]To enable LDAP authentication using the object on an appliance, you must apply a system policy with that object enabled to the appliance. For more information, see Enabling External Authentication and Applying a System Policy. 
 
      
       
       	 [bookmark: pgfId-6368363]If the test fails, see Tuning Your Basic LDAP Authentication Connection for suggestions for troubleshooting the connection. Note that the error message that appears indicates what caused the connection to fail.
 
      
 
     
 
     [bookmark: pgfId-6368364]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368367][bookmark: 34281]LDAP Authentication Object Exa[bookmark: marker-6368366]mples
 
     [bookmark: pgfId-6368371]License: Any
 
     [bookmark: pgfId-6368372]The following sections provide an example of LDAP configuration using basic settings and an example using more advanced configuration options:
 
      
      	 [bookmark: pgfId-6368376]Example: Basic LDAP Configuration
 
      	 [bookmark: pgfId-6368380]Example: Advanced LDAP Configuration
 
     
 
    
 
     
      [bookmark: pgfId-6368382][bookmark: 70606]Example: Basic LDAP Configuration
 
     [bookmark: pgfId-6368386]License: Any
 
     [bookmark: pgfId-6463453]The following figures illustrate a basic configuration of an LDAP login authentication object for a Microsoft Active Directory Server. The LDAP server in this example has an IP address of 10.11.3.4. The connection uses port 389 for access.
 
     [bookmark: pgfId-6647442]
 
      
      [image: ] 
     
 
      
       [bookmark: pgfId-6542607]
 
       
       [image: ] 
      
 
     
 
      
       [bookmark: pgfId-6542612]
 
      [bookmark: pgfId-6368406]However, because this server is a Microsoft Active Directory server, it uses the sAMAccountName attribute to store user names rather than the uid attribute. Selecting the MS Active Directory server type and clicking Set Defaults sets the UI Access Attribute to sAMAccountName. As a result, the FireSIGHT System checks the sAMAccountName attribute for each object for matching user names when a user attempts to log into the FireSIGHT System. 
 
      [bookmark: pgfId-6368413]In addition, a Shell Access Attribute of sAMAccountName causes each sAMAccountName attribute to be checked for all objects in the directory for matches when a user logs into a shell account on the appliance. 
 
      [bookmark: pgfId-6368417]Note that because no base filter is applied to this server, the FireSIGHT System checks attributes for all objects in the directory indicated by the base distinguished name. Connections to the server time out after the default time period (or the timeout period set on the LDAP server).
 
     
 
    
 
     
      [bookmark: pgfId-6368419][bookmark: 77497]Example: Advanced LDAP Configuration
 
     [bookmark: pgfId-6368423]License: Any
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
     [bookmark: pgfId-6368451]The connection to the server is encrypted using SSL and a certificate named certificate.pem is used for the connection. In addition, connections to the server time out after 60 seconds because of the Timeout setting. 
 
     [bookmark: pgfId-6368452]Because this server is a Microsoft Active Directory server, it uses the sAMAccountName attribute to store user names rather than the uid attribute. Note that the configuration includes a UI Access Attribute of sAMAccountName. As a result, the FireSIGHT System checks the sAMAccountName attribute for each object for matching user names when a user attempts to log into the FireSIGHT System. 
 
     [bookmark: pgfId-6368459]In addition, a Shell Access Attribute of sAMAccountName causes each sAMAccountName attribute to be checked for all objects in the directory for matches when a user logs into a shell account on the appliance. 
 
     [bookmark: pgfId-6368460]This example also has group settings in place. The Maintenance User role is automatically assigned to all members of the group with a member group attribute and the base domain name of CN=SFmaintenance,DC=it,DC=example,DC=com. 
 
     [bookmark: pgfId-6647539]
 
      
      [image: ] 
     
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-6368489][bookmark: 88305]Editing LDAP Authentication[bookmark: marker-6368488] Objects
 
     [bookmark: pgfId-6368493]License: Any
 
     [bookmark: pgfId-6368494]You can edit an existing authentication object. Your changes do not take effect until you reapply the policy.
 
     [bookmark: pgfId-6368495]To edit an authentication object:
 
     [bookmark: pgfId-6368499]Access: Admin
 
     
 
     [bookmark: pgfId-6368500]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-6368501]The User Management page appears.
 
     [bookmark: pgfId-6368502]Step 2 Click the External Authentication tab.
 
     [bookmark: pgfId-6368503]The External Authentication page appears. 
 ) next to the object you want to edit. 
     
 
     [bookmark: pgfId-6368508]The Create External Authentication Object page appears.
 
     [bookmark: pgfId-6368509]Step 4 Modify the object settings as needed.
 
     [bookmark: pgfId-6368512]Step 5 Click Test.
 
     [bookmark: pgfId-6368513]A message appears, either indicating success of the test or detailing what settings are missing or need to be corrected. If the test succeeds, the test output appears at the bottom of the page.
 
     [bookmark: pgfId-6368517]If the test fails, see Tuning Your Basic LDAP Authentication Connection for suggestions for troubleshooting the connection. Note that the error message that appears indicates what caused the connection to fail.
 
     [bookmark: pgfId-6368518]Step 6 Click Save.
 
     [bookmark: pgfId-6368519]Your changes are saved and the External Authentication page appears. Remember that you must apply a system policy with the object enabled to an appliance before the authentication changes take place on that appliance. For more information, see Enabling External Authentication and Applying a System Policy.
 
     [bookmark: pgfId-6448251]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6448253][bookmark: 41642]RADIUS Authe[bookmark: marker-6449936]ntication
 
     [bookmark: pgfId-6448254]The Remote Authentication Dial In User Service (RADIUS) is an authentication protocol used to authenticate, authorize, and account for user access to network resources. You can create an authentication object for any RADIUS server that conforms to RFC 2865. 
 
     [bookmark: pgfId-6368530]See the following sections for more information:
 
      
      	 [bookmark: pgfId-6368534]Understanding RADIUS Authentication
 
      	 [bookmark: pgfId-6368538]Creating RADIUS Authentication Objects
 
      	 [bookmark: pgfId-6368542]Configuring RADIUS Connection Settings
 
      	 [bookmark: pgfId-6368546]Configuring RADIUS User Roles
 
      	 [bookmark: pgfId-6368550]Configuring Administrative Shell Access
 
      	 [bookmark: pgfId-6448241]Defining Custom RADIUS Attributes
 
     
 
    
 
     
      [bookmark: pgfId-6448244][bookmark: 37783]Understanding RADIUS Authent[bookmark: marker-6448243]ication
 
     [bookmark: pgfId-6448248]License: Any
 
     [bookmark: pgfId-6368562]When a user authenticated on a RADIUS server logs in for the first time, the user receives the roles specified for that user in the authentication object. If the user is not listed for any of the user roles, they receive the default access role you selected in the authentication object. If no default access role is selected in the authentication object, they receive the default access role from the system policy. You can modify a user’s roles, if needed, unless the settings are granted through the user lists in the authentication object. Note that when a user authenticated on a RADIUS server using attribute matching attempts to log in for the first time, the login is rejected as the user account is created. The user must log in a second time.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368566]Note Before enabling external authentication on Series 3 managed devices, remove any internally-authenticated shell users that have the same user name as externally-authenticated users included in your shell access filter.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368570]The FireSIGHT System implementation of RADIUS supports the use of SecurID tokens. When you configure authentication by a server using SecurID, users authenticated against that server append the SecurID token to the end of their SecurID PIN and use that as their password when they log into a Cisco appliance. As long as SecurID is configured correctly to authenticate users outside the FireSIGHT System, those users can log into a FireSIGHT System appliance using their PIN plus the SecurID token without any additional configuration on the appliance.
 
    
 
     
      [bookmark: pgfId-6368582][bookmark: 68987]Creating RADIUS[bookmark: marker-6368581] Authentication Objects
 
     [bookmark: pgfId-6368586]License: Any
 
     [bookmark: pgfId-6368587]When you create a RADIUS authentication object, you define settings that let you connect to an authentication server. You also grant user roles to specific and default users. If your RADIUS server returns custom attributes for any users you plan to authenticate, you must define those custom attributes. Optionally, you can also configure shell access authentication. 
 
     [bookmark: pgfId-6368588]Note that to create an authentication object, you need TCP/IP access from your local appliance to the authentication server where you want to connect.
 
     [bookmark: pgfId-6368589]To create an authentication object:
 
     [bookmark: pgfId-6368593]Access: Admin
 
     
 
     [bookmark: pgfId-6368594]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-6368595]The User Management page appears.
 
     [bookmark: pgfId-6368596]Step 2 Click the External Authentication tab.
 
     [bookmark: pgfId-6368597]The External Authentication page appears. 
 
     [bookmark: pgfId-6368598]Step 3 Click Create External Authentication Object.
 
     [bookmark: pgfId-6368599]The Create External Authentication Object page appears.
 
     [bookmark: pgfId-6368600]Step 4 Identify the primary and backup authentication servers where you want to retrieve user data for external authentication and set timeout and retry values. For more information, see Configuring RADIUS Connection Settings.
 
     [bookmark: pgfId-6368604]Step 5 Set the default user role. Optionally, specify the users or user attribute values for users that you want to receive specific FireSIGHT System access roles. For more information, see Configuring RADIUS User Roles.
 
     [bookmark: pgfId-6368611]Step 6 Optionally, configure administrative shell access. For more information, see Configuring Administrative Shell Access.
 
     [bookmark: pgfId-6368615]Step 7 If the profiles for any of the users to authenticate return custom RADIUS attributes, define those attributes. For more information, see Defining Custom RADIUS Attributes.
 
     [bookmark: pgfId-6368619]Step 8 Test your configuration by entering the name and password for a user who should successfully authenticate. For more information, see Testing User Authentication.
 
     [bookmark: pgfId-6368623]Your changes are saved. Remember that you must apply a system policy with the object enabled to an appliance before the authentication changes take place on that appliance. For more information, see Enabling External Authentication and Applying a System Policy.
 
     [bookmark: pgfId-6368630]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368633][bookmark: 98035]Configuring RADIUS Connect[bookmark: marker-6368632]ion Settings
 
     [bookmark: pgfId-6368637]License: Any
 
     [bookmark: pgfId-6368638]When you create a RADIUS authentication object, you first specify the primary and backup server and server port where you want the local appliance (managed device or Defense Center) to connect for authentication. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6368642]Note For RADIUS to function correctly, you must open its authentication and accounting ports (by default, 1812 and 1813) on your firewall.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368643]If you specify a backup authentication server, you can set a timeout for the connection attempt to the primary server. If the number of seconds indicated in the Timeout field (or the timeout on the LDAP server) elapses without a response from the primary authentication server, the appliance then re-queries the primary server. 
 
     [bookmark: pgfId-6368644]After the appliance re-queries the primary authentication server the number of times indicated by the Retries field and the number of seconds indicated in the Timeout field again elapses without a response from the primary authentication server, the appliance then rolls over to the backup server. 
 
     [bookmark: pgfId-6368645]If, for example, the primary server has RADIUS disabled, the appliance queries the backup server. If RADIUS is running on the port of the primary RADIUS server and for some reason refuses to service the request (due to misconfiguration or other issues), however, the failover to the backup server does not occur. 
 
     [bookmark: pgfId-6368646]To identify a RADIUS authentication server:
 
     [bookmark: pgfId-6368650]Access: Admin
 
     
 
     [bookmark: pgfId-6368651]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-6368652]The User Management page appears.
 
     [bookmark: pgfId-6368653]Step 2 Click the External Authentication tab.
 
     [bookmark: pgfId-6368654]The External Authentication page appears. 
 
     [bookmark: pgfId-6368655]Step 3 Click Create External Authentication Object.
 
     [bookmark: pgfId-6368656]The Create External Authentication Object page appears.
 
     [bookmark: pgfId-6368657]Step 4 Select RADIUS from the Authentication Method drop-down list.
 
     [bookmark: pgfId-6368658]RADIUS configuration options appear.
 
     [bookmark: pgfId-6368659]Step 5 Type a name and description for the authentication server in the Name and Description fields.
 
     [bookmark: pgfId-6368660]Step 6 Type the IP address or host name for the primary RADIUS server where you want to obtain authentication data in the Primary Server Host Name/IP Address field.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368661]Note IPv6 addresses are not supported for shell authentication. To allow shell authentication when using an IPv6 address for your primary RADIUS server, set up an authentication object using an IPv4 address for the server and use that IPv4 object as the first authentication object in your system policy. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368662]Step 7 Optionally, modify the port used by the primary RADIUS authentication server in the Primary Server Port field.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368663]Note If your authentication port and accounting port numbers are not sequential, leave this field blank. The system then determines RADIUS port numbers from the radius and radacct data in your appliance’s /etc/services file.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368664]Step 8 Type the secret key for the primary RADIUS authentication server in the RADIUS Secret Key field.
 
     [bookmark: pgfId-6368665]Step 9 Type the IP address or host name for the backup RADIUS authentication server where you want to obtain authentication data in the Backup Server Host Name/IP Address field.
 
     [bookmark: pgfId-6368666]Step 10 Optionally, modify the port used by the backup RADIUS authentication server in the Backup Server Port field.
 
      
       
     
 
     
 
     [bookmark: pgfId-6368667]Note If your authentication port and accounting port numbers are not sequential, leave this field blank. The system then determines RADIUS port numbers from the radius and radacct data in your appliance’s /etc/services file.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368668]Step 11 Type the secret key for the backup RADIUS authentication server in the RADIUS Secret Key field.
 
     [bookmark: pgfId-6368669]Step 12 Type the number of seconds that should elapse before retrying the connection in the Timeout field.
 
     [bookmark: pgfId-6368670]Step 13 Type the number of times the primary server connection should be tried before rolling over to the backup connection in the Retries field.
 
     [bookmark: pgfId-6368674]Step 14 Continue with Configuring RADIUS User Roles.
 
     [bookmark: pgfId-6368675]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368678][bookmark: 21080]Configuring RADIUS[bookmark: marker-6368677] User Roles
 
     [bookmark: pgfId-6368682]License: Any
 
     [bookmark: pgfId-6368683]You can specify the access roles for existing users on your RADIUS server by listing the user names for each of the access roles used by your FireSIGHT System. When you do so, you can also configure a default access setting for those users detected by RADIUS that are not specified for a particular role. 
 
     [bookmark: pgfId-6368690]When a user logs in, the FireSIGHT System checks the RADIUS server and grants access rights depending on the RADIUS configuration: 
 
      
      	 [bookmark: pgfId-6368691]If specific access rights are not configured for a user and a default access role is not selected, when a new user logs in, the FireSIGHT System authenticates the user against the RADIUS server and then grants user rights based on the default access role (or roles) set in the system policy. 
 
      	 [bookmark: pgfId-6368695]If a new user is not specified on any lists and default access roles are selected in the  Default User Role list of the authentication object, the user is assigned those access roles. 
 
      	 [bookmark: pgfId-6368696]If you add a user to the list for one or more specific role, that user receives all assigned access roles. 
 
     
 
     [bookmark: pgfId-6368697]You can also use attribute-value pairs, rather than user names, to identify users who should receive a particular user role. For example, if you know all users who should be Security Analysts have the value Analyst for their User-Category attribute, you can type User-Category=Analyst in the Security Analyst List field to grant that role to those users. Note that you need to define any custom attributes before you use them to set user role membership. For more information, see Defining Custom RADIUS Attributes.
 
     [bookmark: pgfId-6368701]You can assign a default user role (or roles) to be assigned to any users that are authenticated externally but not listed for a specific role. You can select multiple roles on the Default User Role list. 
 
     [bookmark: pgfId-6368707]For more information on the user roles supported by the FireSIGHT System, see Configuring RADIUS User Roles.
 
     [bookmark: pgfId-6368709]You cannot remove the minimum access rights for users assigned an access role because of RADIUS user list membership through the FireSIGHT System user management page. You can, however, assign additional rights.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-6368713] 
      Caution If you want to change the minimum access setting for a user, you must not only move the user from one list to another in the RADIUS Specific Parameters section or change the user’s attribute on the RADIUS server, you must reapply the system policy, and you must remove the assigned user right on the user management page. 
       
       
 
      
 
     
 
     [bookmark: pgfId-6368714]To base access on user lists:
 
     [bookmark: pgfId-6368718]Access: Admin
 
     
 
     [bookmark: pgfId-6368722]Step 1 In the fields that correspond to FireSIGHT System user roles, type the name of each user or identifying attribute-value pair that should be assigned to those roles. Separate usernames and attribute-value pairs with commas.
 
     [bookmark: pgfId-6368723]For example, to grant the Administrator role to the users jsmith and jdoe, type jsmith, jdoe in the Administrator field.
 
     [bookmark: pgfId-6368724]As another example, to grant the Maintenance User role to all users with a User-Category value of Maintenance, type User-Category=Maintenance in the Maintenance User field.
 
     [bookmark: pgfId-6368728]For more information on user access roles, see Configuring User Roles.
 
     [bookmark: pgfId-6368729]Step 2 Select the default minimum access role for users that do not belong to any of the specified groups from the Default User Role list. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6368730]Tip Press the Ctrl key while clicking role names to select multiple roles.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368734]Step 3 Continue with Configuring Administrative Shell Access.
 
     [bookmark: pgfId-6368735]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368738][bookmark: 11628]Configuring Administrative[bookmark: marker-6368737] Shell Access
 
     [bookmark: pgfId-6368742]License: Any
 
     [bookmark: pgfId-6368743]You can also use the RADIUS server to authenticate accounts for shell access on your local appliance (managed device or Defense Center). Specify user names for users you want to grant shell access. Note that you can only configure shell access for the first authentication object in your system policy. For more information on managing authentication object order, see Enabling External Authentication.
 
      
       
     
 
     
 
     [bookmark: pgfId-6582706]Note IPv6 addresses are not supported for shell authentication. If you configure a primary RADIUS server with an IPv6 address and also configure administrative shell access, the shell access settings are ignored. To allow shell authentication when using an IPv6 address for your primary RADIUS server, set up another authentication object using an IPv4 address for the server and use that object as the first authentication object in your system policy. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368751]With the exception of the admin account, the shell access list you set on the RADIUS authentication object entirely controls shell access on the appliance. Shell users are configured as local users on the appliance when the system policy is applied. Note that when a user authenticated on a RADIUS server using attribute matching attempts to log in for the first time, the login is rejected as the user account is created. The user must log in a second time.
 
     [bookmark: pgfId-6368752]Note that a home directory for each shell user is created on login, and when an RADIUS shell access user account is disabled (by disabling the RADIUS connection), the directory remains, but the user shell is set to /bin/false in /etc/password to disable the shell. If the user then is re-enabled, the shell is reset, using the same home directory. 
 
     [bookmark: pgfId-6368753]Shell users can log in using user names with lowercase letters. Login authentication for the shell is case sensitive.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-6368760] 
      Caution On Series 3 Defense Centers, all shell users have 
      sudoers privileges. Make sure that you restrict the list of users with shell access appropriately. On Series 3 and virtual devices, shell access granted to externally authenticated users defaults to the 
      Configuration level of command line access, which also grants 
      sudoers privileges. 
       
       
 
      
 
     
 
     [bookmark: pgfId-6368764]To configure shell account authentication:
 
     [bookmark: pgfId-6368768]Access: Admin
 
     
 
     [bookmark: pgfId-6368769]Step 1 Type the user names, separated by commas, in the Administrator Shell Access User List field. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6368770]Note If you choose not to specify a shell access filter, a warning displays when you save the authentication object to confirm that you meant to leave the filter blank.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368774]Step 2 Continue with Defining Custom RADIUS Attributes.
 
     [bookmark: pgfId-6368775]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368778][bookmark: 65705]Defining Custom RADIUS Attr[bookmark: marker-6368777]ibutes
 
     [bookmark: pgfId-6368782]License: Any
 
     [bookmark: pgfId-6368783]If your RADIUS server returns values for attributes not included in the dictionary file in /etc/radiusclient/ and you plan to use those attributes to set user roles for users with those attributes, you need to define those attributes in the login authentication object. 
 
     [bookmark: pgfId-6368784]You can locate the attributes returned for a user by looking at the user’s profile on your RADIUS server. 
 
     [bookmark: pgfId-6368785]When you define an attribute, you provide the name of the attribute, which consists of alphanumeric characters. Note that words in an attribute name should be separated by dashes rather than spaces. You also provide the attribute ID, which should be an integer and should not conflict with any existing attribute IDs in the etc/radiusclient/dictionary file. You also specify the type of attribute: string, IP address, integer, or date. 
 
     [bookmark: pgfId-6368786]As an example, if a RADIUS server is used on a network with a Cisco router, you might want to use the Ascend-Assign-IP-Pool attribute to grant a specific role to all users logging in from a specific IP address pool. Ascend-Assign-IP-Pool is an integer attribute that defines the address pool where the user is allowed to log in, with the integer indicating the number of the assigned IP address pool. To declare that custom attribute, you create a custom attribute with an attribute name of Ascend-IP-Pool-Definition, an attribute ID of 218, and an attribute type of integer. You could then type Ascend-Assign-IP-Pool=2 in the Security Analyst (Read Only) field to grant read-only security analyst rights to all users with an Ascend-IP-Pool-Definition attribute value of 2.
 
     [bookmark: pgfId-6368787]When you create a RADIUS authentication object, a new dictionary file for that object is created on the FireSIGHT System appliance in the /var/sf/userauth directory. Any custom attributes you add to the authentication object are added to the dictionary file. 
 
     [bookmark: pgfId-6368791]To define a custom attribute:
 
     [bookmark: pgfId-6368795]Access: Admin
 
     
 
     [bookmark: pgfId-6368796]Step 1 Click the arrow to expand the Define Custom RADIUS Attributes section.
 
     [bookmark: pgfId-6368797]The attribute fields appear.
 
     [bookmark: pgfId-6368798]Step 2 Type an attribute name consisting of alphanumeric characters and dashes, with no spaces, in the Attribute Name field.
 
     [bookmark: pgfId-6368799]Step 3 Type the attribute ID, in integer form, in the Attribute ID field.
 
     [bookmark: pgfId-6368800]Step 4 Select the type of attribute from the Attribute Type drop-down list. 
 
     [bookmark: pgfId-6368801]Step 5 Click Add to add the custom attribute to the authentication object. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6368802]Tip You can remove a custom attribute from an authentication object by clicking Delete next to the attribute. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368806]Step 6 Continue with Testing User Authentication.
 
     [bookmark: pgfId-6368807]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368810][bookmark: 31894]Testing User Authen[bookmark: marker-6368809]tication
 
     [bookmark: pgfId-6368814]License: Any
 
     [bookmark: pgfId-6368815]After you configure RADIUS connection, user role, and custom attribute settings, you can specify user credentials for a user who should be able to authenticate to test those settings.
 
     [bookmark: pgfId-6368816]For the user name, you can enter the user name for the user you want to test with. 
 
     [bookmark: pgfId-6368817]Note that testing the connection to servers with more than 1000 users only returns 1000 users because of UI page size limitations. 
 
      
       
     
 
     
 
     [bookmark: pgfId-6368818]Tip If you mistype the name or password of the test user, the test fails even if the server configuration is correct. To verify that the server configuration is correct, click Test without entering user information in the Additional Test Parameters field first. If that succeeds, supply a user name and password to test with the specific user. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6368819]To test user authentication:
 
     [bookmark: pgfId-6368823]Access: Admin
 
     
 
     [bookmark: pgfId-6368824]Step 1 In the User Name and Password fields, type the user name and password for the user whose credentials should be used to validate access to the RADIUS server.
 
     [bookmark: pgfId-6368825]For example, to test to see if you can retrieve the jsmith user credentials at our example company, type jsmith.
 
     [bookmark: pgfId-6368826]Step 2 Select Show Details and click Test. 
 
     [bookmark: pgfId-6368827]A message appears, either indicating success of the test or detailing what settings are missing or need to be corrected.
 
     [bookmark: pgfId-6368828]Step 3 If the test succeeds, click Save.
 
     [bookmark: pgfId-6368829]The External Authentication page appears, with the new object listed.
 
     [bookmark: pgfId-6368830]To enable RADIUS authentication using the object on an appliance, you must apply a system policy with that object enabled to the appliance. For more information, see Enabling External Authentication and Applying a System Policy.
 
     [bookmark: pgfId-6368837]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6368839]RADIUS Authentica[bookmark: marker-6368838]tion Object Examples
 
     [bookmark: pgfId-6368843]License: Any
 
     [bookmark: pgfId-6368846]This section provides examples of RADIUS server authentication objects to show how FireSIGHT System RADIUS authentication features can be used. See the following sections for more information:
 
      
      	 [bookmark: pgfId-6368848]Example: Authenticating a User Using RADIUS
 
      	 [bookmark: pgfId-6617175]Example: Authenticating a User with Custom Attributes
 
     
 
    
 
     
      [bookmark: pgfId-6368849][bookmark: 80790]Example: Authenticating a User Using RADIUS
 
     [bookmark: pgfId-6368853]License: Any
 
     [bookmark: pgfId-6368854]The following figure illustrates a sample RADIUS login authentication object for a server running FreeRADIUS with an IP address of 10.10.10.98. Note that the connection uses port 1812 for access, and note that connections to the server time out after 30 seconds of disuse, then retry three times before attempting to connect to a backup authentication server.
 
     [bookmark: pgfId-6368855]This example illustrates important aspects of RADIUS user role configuration: 
 
      
      	 [bookmark: pgfId-6368859]Users  ewharton and  gsand are granted administrative access to FireSIGHT System appliances where this authentication object is enabled. 
 
      	 [bookmark: pgfId-6368863]The user  cbronte is granted Maintenance User access to FireSIGHT System appliances where this authentication object is enabled. 
 
      	 [bookmark: pgfId-6368867]The user  jausten is granted Security Analyst access to FireSIGHT System appliances where this authentication object is enabled. 
 
      	 [bookmark: pgfId-6368868]The user  ewharton can log into the appliance using a shell account. 
 
     
 
     [bookmark: pgfId-6368869]The following graphic depicts the role configuration for the example:
 
     [bookmark: pgfId-6647587]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-6368878][bookmark: 52582]Example: Authenticating a User with Custom Attributes
 
     [bookmark: pgfId-6368882]License: Any
 
     [bookmark: pgfId-6368883]You can use an attribute-value pair to identify users who should receive a particular user role. If the attribute you use is a custom attribute, you must define the custom attribute.
 
     [bookmark: pgfId-6368884]The following figure illustrates the role configuration and custom attribute definition in a sample RADIUS login authentication object for the same FreeRADIUS server as in the previous example. 
 
     [bookmark: pgfId-6368885]In this example, however, the MS-RAS-Version custom attribute is returned for one or more of the users because a Microsoft remote access server is in use. Note the MS-RAS-Version custom attribute is a string. In this example, all users logging in to RADIUS through a Microsoft v. 5.00 remote access server should receive the Security Analyst (Read Only) role, so you type the attribute-value pair of MS-RAS-Version=MSRASV5.00 in the Security Analyst (Read Only) field. 
 
     [bookmark: pgfId-6647611]
 
      
      [image: ] 
     
 
    
 
     
      [bookmark: pgfId-6368895]Editing RADIUS Authe[bookmark: marker-6368894]ntication Objects
 
     [bookmark: pgfId-6368899]License: Any
 
     [bookmark: pgfId-6368900]You can edit an existing authentication object. If the object is in use in a system policy, the settings in place at the time the policy was applied stay in effect until you reapply the policy.
 
     [bookmark: pgfId-6368901]To edit an authentication object:
 
     [bookmark: pgfId-6368905]Access: Admin
 
     
 
     [bookmark: pgfId-6368906]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-6368907]The User Management page appears.
 
     [bookmark: pgfId-6368908]Step 2 Click the External Authentication tab.
 
     [bookmark: pgfId-6368909]The External Authentication page appears. 
 ) next to the object you want to edit. 
     
 
     [bookmark: pgfId-6368914]The Create External Authentication Object page appears.
 
     [bookmark: pgfId-6368915]Step 4 Modify the object settings as needed.
 
     [bookmark: pgfId-6368918]Step 5 Click Save.
 
     [bookmark: pgfId-6368919]Your changes are saved and the External Authentication page reappears. Remember that you must apply a system policy with the object enabled to an appliance before the authentication changes take place on that appliance. For more information, see Enabling External Authentication and Applying a System Policy.
 
     [bookmark: pgfId-6448269]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-6448272][bookmark: 90651]Deleting Authentication[bookmark: marker-6448271] Objects
 
     [bookmark: pgfId-6448276]License: Any
 
     [bookmark: pgfId-6368934]You can delete an authentication object if it is not currently enabled in a system policy. 
 
     [bookmark: pgfId-6368935]To delete an authentication object:
 
     [bookmark: pgfId-6368939]Access: Admin
 
     
 
     [bookmark: pgfId-6368940]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-6368941]The User Management page appears.
 
     [bookmark: pgfId-6368942]Step 2 Click the External Authentication tab.
 
     [bookmark: pgfId-6368943]The External Authentication page appears. 
 ) next to the object you want to delete. 
     
 
     [bookmark: pgfId-6368948]The object is deleted and the External Authentication page appears.
 
     [bookmark: pgfId-6368949]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4588533][bookmark: 13745]Managing User[bookmark: marker-4665490] Accounts
 
    [bookmark: pgfId-6025252]License: Any
 
    [bookmark: pgfId-5887616]If you have Administrator access, you can use the web interface to view and manage user accounts on a Defense Center or a managed device, including adding, modifying, and deleting accounts. You can also create and modify custom user roles and configure user role escalation. User accounts without Administrator access are restricted from accessing management features. The navigation menu differs in appearance for each type of user. 
 
    [bookmark: pgfId-5398301]See the following sections for more information about managing user accounts:
 
     
     	 [bookmark: pgfId-1061324]Viewing User Accounts explains how to access the User Management page, where you can add, activate, deactivate, edit, and delete user accounts.
 
     	 [bookmark: pgfId-1061393]Adding New User Accounts describes the different options you can use when you add a new user account.
 
     	 [bookmark: pgfId-6558634]Managing Command Line Access describes how to assign command line interface access to local device users on Series 3 or virtual devices.
 
     	 [bookmark: pgfId-5887630]Managing Externally Authenticated User Accounts explains how externally authenticated users are added and what aspects of the user configuration you can manage within the FireSIGHT System.
 
     	 [bookmark: pgfId-5405871]Modifying User Privileges and Options explains how to access and modify an existing user account.
 
     	 [bookmark: pgfId-5887641]Understanding Restricted User Access Properties explains how to restrict the data available to a user account with restricted data access.
 
     	 [bookmark: pgfId-1061420]Deleting User Accounts explains how to delete user accounts.
 
     	 [bookmark: pgfId-5887649]User Account Privileges contains tables that list the menus and options each type of user account can access.
 
    
 
     
      [bookmark: pgfId-1060533][bookmark: 40743]Viewing User Accounts
 
     [bookmark: pgfId-5887664]License: Any
 
     [bookmark: pgfId-4546590]From the User Management page, you can view, edit, and delete existing accounts. You can view the type of authentication for a user from the Authentication Method column. The Password Lifetime column indicates the days remaining on each user’s password. The icons in the Action column allow you to edit users in more detail and set users active or inactive. Note that for externally authenticated users, if the authentication object for the server is disabled, the Authentication Method column displays External (Disabled).
 
     [bookmark: pgfId-4786626]To access the User Management page:
 
     [bookmark: pgfId-4786633]Access: Admin
 
     
 
     [bookmark: pgfId-1849366]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-1851493]The User Management page appears, showing each user, with options to activate, deactivate, edit, or delete the user account. 
 
     [bookmark: pgfId-1103676]See the following sections for information about the actions you can perform on the User Management page:
 
      
       
       	 [bookmark: pgfId-1345471]Adding New User Accounts
 
       	 [bookmark: pgfId-5405931]Configuring User Roles
 
       	 [bookmark: pgfId-4787188]Modifying User Privileges and Options
 
       	 [bookmark: pgfId-5887673]Understanding Restricted User Access Properties
 
       	 [bookmark: pgfId-5405903]Modifying User Passwords
 
       	 [bookmark: pgfId-5405908]Deleting User Accounts
 
      
 
     
 
     [bookmark: pgfId-6286558]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1060544][bookmark: 86769]Adding New User Accounts
 
     [bookmark: pgfId-5887688]License: Any
 
     [bookmark: pgfId-6068641]Supported Devices: feature dependent
 
     [bookmark: pgfId-5408790]When you set up a new user account, you can control which parts of the system the account can access. You can set password expiration and strength settings for the user account during creation. For a local account on a Series 3 device, you can also configure the level of command line access the user will have.
 
     [bookmark: pgfId-4609998]To add a new user:
 
     [bookmark: pgfId-4756231]Access: Admin
 
     
 
     [bookmark: pgfId-5899774]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-4490901]The User Management page appears. 
 
     [bookmark: pgfId-4490925]Step 2 Click Create User.
 
     [bookmark: pgfId-1061719]The Create User page appears. 
 
     [bookmark: pgfId-5937978]Step 3 In the User Name field, type a name for the new user.
 
     [bookmark: pgfId-4690420]New user names must contain alphanumeric or hyphen characters with no spaces, and must be no more than 32 characters. User names are case sensitive.
 
     [bookmark: pgfId-5887704]Step 4 If you want this user to authenticate to an external directory server on login, select Use External Authentication Method.
 
     [bookmark: pgfId-5887708]If you enable this option, the password management options disappear. Skip to step 8 to continue with configuring an access role for the user.
 
     [bookmark: pgfId-6398244]Note that for users to authenticate to an external directory server, you must use the Defense Center to create an authentication object for the server you want to use, then apply a system policy with authentication enabled. In addition, the external authentication server must be available in order for those users to log into FireSIGHT System appliances. For more information, see Managing Authentication Objects and Enabling External Authentication.
 
     [bookmark: pgfId-1061954]Step 5 In the Password and Confirm Password fields, type a password (up to 32 alphanumeric characters).
 
     [bookmark: pgfId-1061958]If you enable password strength checking, the password must be at least eight alphanumeric characters of mixed case and must include at least one numeric character and one special character. It cannot be a word that appears in a dictionary or include consecutive repeating characters.
 
      
       
     
 
     
 
     [bookmark: pgfId-6085694]Note If you enable STIG compliance on an appliance, see the FireSIGHT System STIG Release Notes for more information on password settings for shell access users.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4806646]Step 6 Configure the remaining user account login options.
 
     [bookmark: pgfId-4806649]For more information, see the User Account Login Options table.
 
     [bookmark: pgfId-5887729]Step 7 If you are creating a local user through the web interface of a Series 3 device, you can assign the level of Command-Line Interface Access for the user:
 
      
       
       	 [bookmark: pgfId-5887730]Select  None to disable access to the command line for the user.
 
       	 [bookmark: pgfId-5887731]Select  Basic to allow the user to log into the shell and to access a specific subset of commands.
 
       	 [bookmark: pgfId-5887732]Select  Configuration to allow the user to log into the shell and use any command line option, including expert mode if that is allowed on the appliance.
 
      
 
     
 
     [bookmark: pgfId-5887735]For more information on command line access, see Managing Command Line Access.
 
     [bookmark: pgfId-5960776]Step 8 [bookmark: 84134]Select access roles to grant to the user. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5960816]Note For all physical managed devices, the Cisco-provided predefined user roles are limited to Administrator, Maintenance User, and Security Analyst.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5960787]For more information, see Configuring User Roles.
 
     [bookmark: pgfId-1726406]Step 9 [bookmark: 16203]Click Save.
 
     [bookmark: pgfId-1062923]The user is created and the User Management page appears again.
 
      
       
     
 
     
 
     [bookmark: pgfId-5408599]Tip Click the slider next to the name of an internally authenticated user on the User Management page to reactivate a deactivated user, or to disable an active user account without deleting it. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6286616]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5887767][bookmark: 84382]Managing Command Line Ac[bookmark: marker-5953922]cess
 
     [bookmark: pgfId-5887772]License: Any
 
     [bookmark: pgfId-6068726]Supported Devices: Series 3, virtual
 
     [bookmark: pgfId-5887776]On a Series 3 or virtual device, you can assign command line interface access to local device users. 
 
     [bookmark: pgfId-5976968]Note that you can also assign command line access for users on a virtual device, but you use commands from the command line interface. For more information, see Command Line Reference.
 
      
       
        
        [bookmark: pgfId-5887792]Table 61-3 Basic Command Line Commands 
 
        
        
         
         	[bookmark: pgfId-5887796]configure password
  
         	[bookmark: pgfId-5887798]interfaces
  
        
 
         
         	[bookmark: pgfId-5887800]end
  
         	[bookmark: pgfId-5887802]lcd
  
        
 
         
         	[bookmark: pgfId-5887804]exit
  
         	[bookmark: pgfId-5887806]link-state
  
        
 
         
         	[bookmark: pgfId-5887808]help
  
         	[bookmark: pgfId-5887810]log-ips-connection
  
        
 
         
         	[bookmark: pgfId-5887812]history
  
         	[bookmark: pgfId-5887814]managers
  
        
 
         
         	[bookmark: pgfId-5887816]logout
  
         	[bookmark: pgfId-5887818]memory
  
        
 
         
         	[bookmark: pgfId-5887820]?
  
         	[bookmark: pgfId-5887822]model
  
        
 
         
         	[bookmark: pgfId-5887824]??
  
         	[bookmark: pgfId-5887826]mpls-depth
  
        
 
         
         	[bookmark: pgfId-5887828]access-control-config
  
         	[bookmark: pgfId-5887830]NAT
  
        
 
         
         	[bookmark: pgfId-5900264]alarms
  
         	[bookmark: pgfId-5887834]network
  
        
 
         
         	[bookmark: pgfId-5900266]arp-tables
  
         	[bookmark: pgfId-5887838]network-modules
  
        
 
         
         	[bookmark: pgfId-5900268]audit-log
  
         	[bookmark: pgfId-5923843]ntp
  
        
 
         
         	[bookmark: pgfId-5900270]bypass
  
         	[bookmark: pgfId-5887846]perfstats
  
        
 
         
         	[bookmark: pgfId-5900272]clustering
  
         	[bookmark: pgfId-5887850]portstats
  
        
 
         
         	[bookmark: pgfId-5900274]cpu
  
         	[bookmark: pgfId-5887854]power-supply-status
  
        
 
         
         	[bookmark: pgfId-5887860]database
  
         	[bookmark: pgfId-6039485]process-tree
  
        
 
         
         	[bookmark: pgfId-5916320]device-settings
  
         	[bookmark: pgfId-6039487]processes
  
        
 
         
         	[bookmark: pgfId-5916316]disk
  
         	[bookmark: pgfId-6039489]routing-table
  
        
 
         
         	[bookmark: pgfId-5916312]disk-manager
  
         	[bookmark: pgfId-6039491]serial-number
  
        
 
         
         	[bookmark: pgfId-5916308]dns
  
         	[bookmark: pgfId-6039493]stacking
  
        
 
         
         	[bookmark: pgfId-5916304]expert
  
         	[bookmark: pgfId-6039495]summary
  
        
 
         
         	[bookmark: pgfId-5916300]fan-status
  
         	[bookmark: pgfId-6039497]time
  
        
 
         
         	[bookmark: pgfId-5916296]fastpath-rules
  
         	[bookmark: pgfId-6039499]traffic-statistics
  
        
 
         
         	[bookmark: pgfId-6011896]gui
  
         	[bookmark: pgfId-6039501]version
  
        
 
         
         	[bookmark: pgfId-5923724]hostname
  
         	[bookmark: pgfId-6039503]virtual-routers
  
        
 
         
         	[bookmark: pgfId-6072667]hyperthreading
  
         	[bookmark: pgfId-6072669]virtual-switches
  
        
 
         
         	[bookmark: pgfId-6072663]inline-sets
  
         	[bookmark: pgfId-6072665]
  
        
 
        
      
 
     
 
     [bookmark: pgfId-5887864]When you set Command-Line Interface Access to Configuration, the user can access any of the command line options. Exercise caution in assigning this level of access to users.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-5887865] 
      Caution Shell access granted to externally authenticated users defaults to the 
      Configuration level of command line access, granting rights to all command line utilities. For more information on shell access for externally authenticated users, see 
      Understanding Shell Access and 
      Configuring Shell Access. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-5887877][bookmark: 68867]Managing Externally Authenticated User[bookmark: marker-5887876] Accounts
 
     [bookmark: pgfId-5887888]License: Any
 
     [bookmark: pgfId-5887889]When an externally authenticated user logs into an appliance that has external authentication enabled, the appliance grants the user the default access role you set by specifying group membership in the authentication object. If you did not configure access group settings, the appliance grants the default user role you set in the system policy. However, if you add users locally before they log into the appliance, the user privileges you configure on the User Management page override the default settings. 
 
     [bookmark: pgfId-6199676]For more information on selecting a default user role, see Enabling External Authentication and Understanding User Privileges. Note that you can set both predefined and custom user roles as the default user role for externally authenticated users. For more information, see Configuring User Roles.
 
     [bookmark: pgfId-5887890]An internally authenticated user is converted to external authentication when all of the following conditions exist: 
 
      
      	 [bookmark: pgfId-5887891]You enable LDAP (with or without CAC) or RADIUS authentication. 
 
      	 [bookmark: pgfId-5887892]The same user name exists for the user on the LDAP or RADIUS server. 
 
      	 [bookmark: pgfId-5887893]The user logs in using the password stored for that user on the LDAP or RADIUS server.
 
     
 
     [bookmark: pgfId-5887907]Note that you can only enable external authentication in a system policy on a Defense Center. You must use the Defense Center to apply the policy to managed devices if you want to use external authentication on them.
 
     [bookmark: pgfId-6371092]After an externally authenticated user logs in to an appliance for the first time, the appliance associates those credentials with a set of permissions by creating a local user record. For more information about user login, see Logging into the Appliance. After initial login, the permissions for that local user record can be modified unless they are granted through group or list membership, as follows:
 
      
      	 [bookmark: pgfId-6371096]If the default role for externally authenticated user accounts is set to a specific access role, users can log into the appliance using their external account credentials without any additional configuration by the system administrator. 
 
      	 [bookmark: pgfId-6371097]If an account is externally authenticated and by default receives no access privileges, users can log in but cannot access any functionality. You (or your system administrator) can then change the permissions to grant the appropriate access to user functionality.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-6371099]Tip The system does not create a local user account for shell acces[bookmark: marker-6371098]s users. Shell access is controlled entirely through either the shell access filter or PAM login attribute set for an LDAP server, or the shell access list on a RADIUS server. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6199299]For more information on modifying user access, see Modifying User Privileges and Options. Note that you cannot manage passwords for externally authenticated users or deactivate externally authenticated users through the FireSIGHT System interface. For externally authenticated users, you cannot remove the minimum access rights through the FireSIGHT System user management page for users assigned an access role because of LDAP group or RADIUS list membership or attribute values. On the Edit User page for an externally authenticated user, rights granted because of settings on an external authentication server are marked with a status of Externally Modified. 
 
     [bookmark: pgfId-6086704]You can, however, assign additional rights. When you modify the access rights for an externally authenticated user, the Authentication Method column on the User Management page provides a status of External - Locally Modified. 
 
     [bookmark: pgfId-6086705]Shell users can log in using user names with lowercase letters. Login authentication for the shell is case sensitive.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-6086712] 
      Caution On Series 3 Defense Centers, all shell users have 
      sudoers privileges. Make sure that you restrict the list of users with shell access appropriately. On Series 3 and virtual devices, shell access granted to externally authenticated users defaults to the 
      Configuration level of command line access, which also grants 
      sudoers privileges. For more information on setting up shell access, see 
      Understanding Shell Access and 
      Configuring Shell Access. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-4787488][bookmark: 73207]Managing User L[bookmark: marker-6068344]ogin Settings
 
     [bookmark: pgfId-5961455]License: Any
 
     [bookmark: pgfId-4787489]You can control how and when the password for each user account is changed, as well as when user accounts are disabled. If you configured a timeout for web interface login sessions, you can exempt users from this timeout. The following table describes some of the options[bookmark: marker-4787493] you can use to regulate passwords and account access. 
 
     [bookmark: pgfId-6051659]Note that for locally authenticated users on Series 3 managed devices, changing a user’s password for the web interface also changes that password for the command line interface.
 
     [bookmark: pgfId-6051669]If you enable the Check Password Strength option, the minimum password length is automatically set to 8 characters. If you also set a value for Minimum Password Length that exceeds 8 characters, the higher value applies.
 
      
       
     
 
     
 
     [bookmark: pgfId-6051660]Note After you enable Use External Authentication Method, login options no longer appear. Use the external authentication server to manage login settings.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4787542]
 
      
       
        
        [bookmark: pgfId-4787501]Table 61-4 [bookmark: 78024]User Account Login Options 
 
        
        
         
         	 
           
           [bookmark: pgfId-4787505]Option 
          
  
         	 
           
           [bookmark: pgfId-4787507]Description 
          
  
        
 
         
         	[bookmark: pgfId-4787509]Use External Authentication Method
  
         	[bookmark: pgfId-4787511]Select this check box if you want this user's credentials to be externally authenticated.
 [bookmark: pgfId-4787512]Note If you select this option for the user and the external authentication server is unavailable, that user can log into the web interface but cannot access any functionality.
  
        
 
         
         	[bookmark: pgfId-4788741]Maximum Number of Failed [bookmark: marker-4788742]Logins
  
         	[bookmark: pgfId-4788744]Enter an integer, without spaces, that determines the maximum number of times each user can try to log in after a failed login attempt before the account is locked. The default setting is five tries; use 0 to allow an unlimited number of failed logins.
  
        
 
         
         	[bookmark: pgfId-6038960]Minimum Pass[bookmark: marker-6068352]word Length
  
         	[bookmark: pgfId-6038962]Enter an integer, without spaces, that determines the minimum required length, in characters, of a user’s password. The default setting is 8. A value of 0 indicates that no minimum length is required.
  
        
 
         
         	[bookmark: pgfId-4788693]Days Until Password Expiration
  
         	[bookmark: pgfId-4788847]Enter the number of days after which the user’s password expires. The default setting is 0, which indicates that the password never expires.
  
        
 
         
         	[bookmark: pgfId-4788697]Days Before Pas[bookmark: marker-6068361]sword Expiration Warning
  
         	[bookmark: pgfId-4788829]Enter the number of warning days users have to change their password before their password actually expires. The default setting is 0 days.
 
           
            
          
 
          
 
           
           [bookmark: pgfId-4788699]Caution The number of warning days must be 
            less than the number of days before the password expires. 
            
            
 
           
 
          
  
        
 
         
         	[bookmark: pgfId-4787515]Force P[bookmark: marker-4787514]assword Reset on Login
  
         	[bookmark: pgfId-4787517]Select this option to force users to change their passwords the first time they log in. 
  
        
 
         
         	[bookmark: pgfId-4787520]Check Password Strengt[bookmark: marker-4787521]h
  
         	[bookmark: pgfId-4787523]Select this option to require strong passwords. A strong password must be at least eight alphanumeric characters of mixed case and must include at least one numeric character and one special character. It cannot be a word that appears in a dictionary or include consecutive repeating characters.
  
        
 
         
         	[bookmark: pgfId-6032519]Exem[bookmark: marker-6068366]pt from Browser Session Timeout
  
         	[bookmark: pgfId-6032521]Select this option if you do not want a user’s login sessions to terminate due to inactivity. Users with the Administrator role cannot be made exempt. For more information on session timeouts, see Configuring User Interface Settings.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-4787929][bookmark: 24996]Configuri[bookmark: marker-5952801]ng User Roles
 
     [bookmark: pgfId-5915444]License: Any
 
     [bookmark: pgfId-5685946]Each FireSIGHT System user has an associated user access role or roles. For example, an analyst needs access to event data to analyze the security of your network, but might not require access to administrative functions for the FireSIGHT System itself. Using user roles, you can, for example, grant Security Analyst access to analysts while reserving the Administrator role for the user or users managing the FireSIGHT System. The FireSIGHT System includes ten predefined user roles designed for a variety of administrators and analysts. You can also create custom user roles with specialized access privileges.
 
     [bookmark: pgfId-5685964]The menus and other options in the web interface that users can access depend on their roles. Predefined user roles have a set of predetermined access privileges, while custom user roles have granular access privileges that their creator determines.
 
     [bookmark: pgfId-5887974]You configure user roles on the User Roles page.
 
     [bookmark: pgfId-5887975]To access the User Roles page:
 
     [bookmark: pgfId-5899935]Access: Admin
 
     
 
     [bookmark: pgfId-5899944]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-5899937]The User Management page appears.
 
     [bookmark: pgfId-5899938]Step 2 Click the User Roles tab.
 
     [bookmark: pgfId-5887980]The User Roles page appears, showing all predefined and custom user roles, with options to activate, deactivate, edit, copy, delete, and export roles.
 
     [bookmark: pgfId-5887981]For more information on configuring the two types of user roles, see the following sections:
 
      
      	 [bookmark: pgfId-5887985]Managing Predefined User Roles
 
      	 [bookmark: pgfId-5887989]Managing Custom User Roles
 
      	 [bookmark: pgfId-5887993]Creating a Custom Copy of a Predefined User Role
 
      	 [bookmark: pgfId-5887997]Deleting a Custom User Role
 
     
 
     [bookmark: pgfId-6286634]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5685982][bookmark: 86221]Managing Prede[bookmark: marker-5952806]fined User Roles
 
     [bookmark: pgfId-5915458]License: Any
 
     [bookmark: pgfId-5888010]The FireSIGHT System includes ten predefined user roles that provide a range of access privilege sets to meet the needs of your organization. On the User Roles page, predefined user roles are labeled “Cisco Provided”. Note that managed devices have access to only three of the ten predefined user roles: Administrator, Maintenance User, and Security Analyst.
 
     [bookmark: pgfId-5888011]Although you cannot edit predefined user roles, you can use their access privilege sets as the basis for custom user roles. For information on creating and editing custom user roles, see Managing Custom User Roles. In addition, because you cannot edit predefined user roles, you cannot configure them to escalate to another user role. For more information, see Managing User Role Escalation.
 
     [bookmark: pgfId-5686000]The following table briefly describes the predefined roles available to you. For a list of the menus and options available to each role, see User Account Privileges.
 
     [bookmark: pgfId-5960942] 
 
      
       
        
        [bookmark: pgfId-6262706]Table 61-5 [bookmark: 26708]Predefined User Roles 
 
        
        
         
         	 
           
           [bookmark: pgfId-6262710]User Role 
          
  
         	 
           
           [bookmark: pgfId-6262712]Privileges 
          
  
        
 
         
         	[bookmark: pgfId-6262714]Access Admin
  
         	[bookmark: pgfId-6262716]Provides access to access control, SSL inspection, and file policy features. Note, however, that Access Admins cannot apply access control policies. Access Admins have access to access control, SSL inspection, and file-related options in the Policies menu.
  
        
 
         
         	[bookmark: pgfId-6262719][bookmark: marker-6262718]Administrator
  
         	[bookmark: pgfId-6262721]Provides access to analysis and reporting features, rule and policy configuration, system management, and all maintenance features. Administrators have access to all menu options; their sessions present a higher security risk if compromised, so you cannot make them exempt from login session timeouts.
 [bookmark: pgfId-6262722]Note that you should limit use of the Administrator role for security reasons.
 [bookmark: pgfId-6262723]This role is also available on managed devices.
  
        
 
         
         	[bookmark: pgfId-6262725]Discovery Admin
  
         	[bookmark: pgfId-6262727]Provides access to network discovery, correlation, and user activity features. Discovery Admins have access to relevant options in the Policies menu.
  
        
 
         
         	[bookmark: pgfId-6262730][bookmark: marker-6262729]External Database User
  
         	[bookmark: pgfId-6262735]Provides read-only access to the FireSIGHT System database using an application that supports JDBC SSL connections. Note that for the third-party application to authenticate to the FireSIGHT System appliance, you must enable database access in the system settings as described in Enabling Access to the Database. On the web interface, External Database Users have access only to online help-related options in the Help menu. Because this role’s function does not involve the web interface, access is provided only for ease of support and password changes.
  
        
 
         
         	[bookmark: pgfId-6262743]Intrusion Admin 
  
         	[bookmark: pgfId-6597871]Provides access to all intrusion policy, intrusion rule, and network analysis policy features. Intrusion Admins have access to intrusion-related options in the Policies menu. Note that Intrusion Admins cannot apply intrusion or network analysis policies as part of access control policies.
  
        
 
         
         	[bookmark: pgfId-6262748][bookmark: marker-6262747]Maintenance User
  
         	[bookmark: pgfId-6262750]Provides access to monitoring and maintenance features. Maintenance Users have access to maintenance-related options in the Health and System menus.
 [bookmark: pgfId-6262751]This role is also available on managed devices.
  
        
 
         
         	[bookmark: pgfId-6262753]Network Admin
  
         	[bookmark: pgfId-6262755]Provides access to access control, SSL inspection, and device configuration features. Network Admins have access to access control, SSL inspection, and device-related options in the Policies and Devices menus.
  
        
 
         
         	[bookmark: pgfId-6262757]Security Analyst
  
         	[bookmark: pgfId-6262759]Provides access to security event analysis features, including event views, reports, hosts, host attributes, services, vulnerabilities, client applications, and read-only access to health events. Security Analysts have access to analysis-related options in the Overview, Analysis, Health, and System menus.
 [bookmark: pgfId-6262760]This role is also available on managed devices.
  
        
 
         
         	[bookmark: pgfId-6262762]Security Analyst (Read Only)
  
         	[bookmark: pgfId-6262764]Provides read-only access to security event analysis features, including event views, reports, hosts, host attributes, services, vulnerabilities, client applications, and health events. Security Analysts have access to analysis-related options in the Overview, Analysis, Health, and System menus.
  
        
 
         
         	[bookmark: pgfId-6262766]Security Approver
  
         	[bookmark: pgfId-6262768]Provides limited access to access control, intrusion, file, SSL, and network discovery policies. Security Approvers can view these policies and apply network discovery, intrusion, and access control policies, but cannot make policy changes. They have access to applicable policy-related options in the Policies menu.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-5960943]Along with assigning an event analyst role to a user, you can restrict that user’s deletion rights to only allow deletion of report profiles, searches, bookmarks, custom tables, and custom workflows created by that user. For more information, see Adding New User Accounts.
 
     [bookmark: pgfId-5888030]Note that externally authenticated users, if assigned no other roles, have minimum access rights based on the settings in LDAP or RADIUS authentication objects and in the system policy. You can assign additional rights to these users, but to remove or change minimum access rights, you must perform the following tasks: 
 
      
      	 [bookmark: pgfId-5888031]Move the user from one list to another in the authentication object or change the user's attribute value or group membership on the external authentication server.
 
      	 [bookmark: pgfId-5888032]Reapply the system policy.
 
      	 [bookmark: pgfId-5888033]Use the User Management page to remove the access from that user account.
 
     
 
     [bookmark: pgfId-5888035]You cannot delete predefined user roles, but you can deactivate them. Deactivating a role removes that role and all associated permissions from any user who is assigned that role. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-5888036] 
      Caution If a deactivated role is the only role assigned to a given user, that user can log in and access the User Preferences menu, but is otherwise unable to access the FireSIGHT System. 
       
       
 
      
 
     
 
     [bookmark: pgfId-5888041][bookmark: 47757]To activate or deact[bookmark: marker-5952811]ivate a user role:
 
     [bookmark: pgfId-5888042]Access: Admin
 
     
 
     [bookmark: pgfId-5899983]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-5888044]The User Management page appears.
 
     [bookmark: pgfId-5888045]Step 2 Click the User Roles tab.
 
     [bookmark: pgfId-5888046]The User Roles page appears.
 
     [bookmark: pgfId-5944139]Step 3 Click the slider next to the user role you want to activate or deactivate.
 
      
       
     
 
     
 
     [bookmark: pgfId-5944153]Note If you deactivate, then reactivate, a role with Lights-Out Management while a user with that role is logged in, or restore a user or user role from a backup during that user’s login session, that user must log back into the web interface to regain access to IPMItool commands. For more information, see Using Lights-Out Management.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6285203]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5944143][bookmark: 94083]Managing Custo[bookmark: marker-5952816]m User Roles
 
     [bookmark: pgfId-5915473]License: Any
 
     [bookmark: pgfId-5888050]In addition to the predefined user roles, you can also create custom user roles with specialized access privileges. Custom user roles can have any set of menu-based and system permissions, and may be completely original or based on a predefined user role. Like predefined user roles, custom roles can serve as the default role for externally authenticated users. Unlike predefined roles, you can modify and delete custom roles.
 
     [bookmark: pgfId-5900295]Selectable permissions are hierarchical, and are based on the FireSIGHT System menu layout. Permissions are expandable if they have sub-pages or if they have more fine-grained permissions available beyond simple page access. In that case, the parent permission grants page view access and the children granular access to related features of that page. For example, the Correlation Events permission grants access to the Correlation Events page, while the Modify Correlation Events check box allows the user to edit and delete the information available on that page. Permissions that contain the word “Manage” grant the ability to edit and delete information that other users create.
 
      
       
     
 
     
 
     [bookmark: pgfId-6612232]Tip For pages or features not included in the menu structure, privileges are granted by parent or related pages. For example, the Modify Intrusion Policy privilege also allows you to modify network analysis policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5888055]You can apply restricted searches to a custom user role. These constrain the data a user may see in the event viewer. You can configure a restricted search by first creating a private saved search and selecting it from the “Restricted Search” drop-down menu under the appropriate menu-based permission. For more information, see Performing a Search.
 
     [bookmark: pgfId-5888059]When you configure a custom user role on a Defense Center, all menu-based permissions are available for you to grant. When you configure a custom user role on a managed device, only some permissions are available — those relevant to device functions. For more information on the menu-based permissions you can configure and their relationship with predefined user roles, see:
 
      
      	 [bookmark: pgfId-5888063]Analysis Menu
 
      	 [bookmark: pgfId-5888067]Policies Menu
 
      	 [bookmark: pgfId-5888071]Devices Menu
 
      	 [bookmark: pgfId-5888075]Object Manager
 
      	 [bookmark: pgfId-5930492]Health Menu
 
      	 [bookmark: pgfId-5930502]System Menu
 
      	 [bookmark: pgfId-5930512]Help Menu
 
     
 
     [bookmark: pgfId-5888076]The selectable options under System Permissions allow you to create a user role that can make queries to the external database or escalate to the permissions of a target user role. For more information, see Enabling Access to the Database and Managing User Role Escalation.
 
     [bookmark: pgfId-5888083]Optionally, instead of creating a new custom user role, you can export a custom user role from another appliance, then import it onto your appliance. You can then edit the imported role to suit your needs before you apply it. For more information, see Exporting Configurations and Importing Configurations.
 
     [bookmark: pgfId-5888096]To create a custom user role:
 
     [bookmark: pgfId-5888097]Access: Admin
 
     
 
     [bookmark: pgfId-5900003]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-5900004]The User Management page appears.
 
     [bookmark: pgfId-5900005]Step 2 Click the User Roles tab.
 
     [bookmark: pgfId-5888101]The User Roles page appears.
 
     [bookmark: pgfId-5888102]Step 3 Click Create User Role.
 
     [bookmark: pgfId-5888103]The User Role Editor page appears.
 
     [bookmark: pgfId-5888108]Step 4 In the Name field, type a name for the new user role.
 
     [bookmark: pgfId-5888109]You can use alphanumeric or hyphen characters, without spaces. Role names must be no more than 75 characters. User role names are case sensitive.
 
     [bookmark: pgfId-5888110]Step 5 Optionally, add a description for the new role in the Description field.
 
     [bookmark: pgfId-5888111]Role descriptions must be no more than 255 characters.
 
     [bookmark: pgfId-5888112]Step 6 Select permissions for the new role.
 
     [bookmark: pgfId-5888113]When you select an unselected permission, all of its children are selected, and the multi-value permissions choose the first value. If you clear a high-level permission, all of its children are cleared also. Selected permissions without all children selected appear in italic text.
 
     [bookmark: pgfId-5888114]Note that choosing to copy a predefined user role to use as the base for your custom role preselects the permissions associated with that predefined role. For more information on copying predefined user roles, see Creating a Custom Copy of a Predefined User Role.
 
     [bookmark: pgfId-5888118]The current escalation target role is listed beside the role escalation check box. If you select this check box, you can then choose to authenticate escalations either with the assigned user’s password or with the password of another specified user role. For more information, see Managing User Role Escalation.
 
     [bookmark: pgfId-5888122]Step 7 Click Save.
 
     [bookmark: pgfId-5888123]The custom user role is created and the User Roles page appears again.
 
     [bookmark: pgfId-6286656]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5888125][bookmark: 51974]Creating a Custom Copy of a Pred[bookmark: marker-5952826]efined User Role
 
     [bookmark: pgfId-5915485]License: Any
 
     [bookmark: pgfId-5888127]You can copy an existing role to use as the basis for a new custom role. This preselects the existing role’s permissions in the User Role Editor so you can model one role on another.
 
     [bookmark: pgfId-5888128]To create a custom copy of a predefined user role:
 
     [bookmark: pgfId-5888129]Access: Admin
 
     
 
     [bookmark: pgfId-5900017]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-5900018]The User Management page appears.
 
     [bookmark: pgfId-5900019]Step 2 Click the User Roles tab.
 
     [bookmark: pgfId-5888133]The User Roles page appears.
 ) next to the user role you want to copy. 
     
 
     [bookmark: pgfId-5888135]The User Role Editor page appears with the copied role’s permissions preselected.
 
     [bookmark: pgfId-5888136]Note that you can copy both custom and predefined user roles in this way.
 
     [bookmark: pgfId-6285222]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5888138][bookmark: 74135]Deleting a Cust[bookmark: marker-5952831]om User Role
 
     [bookmark: pgfId-5961473]License: Any
 
     [bookmark: pgfId-5888139]Unlike predefined user roles, you can delete custom roles that are no longer necessary. If you want to disable a custom role without removing it entirely, you can deactivate it instead; for more information, refer to the procedure in Managing Predefined User Roles. Note that you cannot delete your own user role or a role that is set as a default user role in the system policy. For more information, see Enabling External Authentication.
 
     [bookmark: pgfId-5888146]To delete a custom user role:
 
     [bookmark: pgfId-5888147]Access: Admin
 
     
 
     [bookmark: pgfId-5900031]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-5900032]The User Management page appears.
 
     [bookmark: pgfId-5900033]Step 2 Click the User Roles tab.
 
     [bookmark: pgfId-5888151]The User Roles page appears.
 ) next to the custom role you want to delete. 
     
 
     [bookmark: pgfId-5888153]The custom role is deleted.
 
     [bookmark: pgfId-5888154]If a deleted role is the only role assigned to a given user, that user can log in and access the User Preferences menu, but is otherwise unable to access the FireSIGHT System.
 
     [bookmark: pgfId-6285215]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5372699][bookmark: 94405]Modifying User Privileges and Options[bookmark: marker-1063294]
 
     [bookmark: pgfId-5888175]License: Any
 
     [bookmark: pgfId-1063014]After adding user accounts to the system, you can modify access privileges, account options, or passwords at any time. Note that password management options do not apply to users who authenticate to an external directory server. You manage those settings on the external server. However, you must configure access rights for all accounts, including those that are externally authenticated.
 
     [bookmark: pgfId-4841616]For externally authenticated users, you cannot remove the minimum access rights through the FireSIGHT System user management page for users assigned an access role because of LDAP group or RADIUS list membership or attribute values. You can, however, assign additional rights. When you modify the access rights for an externally authenticated user, the Authentication Method column on the User Management page provides a status of External - Locally Modified.
 
     [bookmark: pgfId-4960752]Note that if you change the authentication for a user from externally authenticated to internally authenticated, you must supply a new password for the user. 
 
     [bookmark: pgfId-1073033]To modify user account privileges:
 
     [bookmark: pgfId-4756254]Access: Admin
 
     
 
     [bookmark: pgfId-5900049]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-4490986]The User Management page appears. 
 ) next to the user you want to modify. 
     
 
     [bookmark: pgfId-4789815]The Edit User page appears. 
 
     [bookmark: pgfId-4789797]Step 3 Modify the account or accounts as needed:
 
      
       
       	 [bookmark: pgfId-5888188]See Managing Externally Authenticated User Accounts for a description of how users can be authenticated through external servers.
 
       	 [bookmark: pgfId-4789905]See Managing User Login Settings for information on changing password settings for internally authenticated users. 
 
       	 [bookmark: pgfId-4789913]See Configuring User Roles for more information on configuring roles to grant access for FireSIGHT System functions. 
 
      
 
     
 
     [bookmark: pgfId-6285278]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5888194][bookmark: 90041]Understanding Restricted User Access Properties
 
     [bookmark: pgfId-5888205]License: Any
 
     [bookmark: pgfId-5888208]You can restrict the data that a user role can view in the event viewer by applying a restricted search to that role. You can specify this information when creating or editing the role assigned to a user. To create a custom role with restricted access, you must choose the tables you want to restrict from the Menu Based Permissions list, then select private saved searches from the Restrictive Search drop-down lists. For more information, see Managing Custom User Roles.
 
    
 
     
      [bookmark: pgfId-4755956][bookmark: 34735]Modifying User Pa[bookmark: marker-4755955]sswords
 
     [bookmark: pgfId-5888224]License: Any
 
     [bookmark: pgfId-6579485]You can modify user passwords from the User Management page for internally authenticated users. Note that you must manage externally authenticated user passwords on the LDAP or RADIUS server.
 
      
       
     
 
     
 
     [bookmark: pgfId-6589581]Note If you enable STIG compliance or Lights-Out Management (LOM) on an appliance, different password restrictions apply. For more information on password settings for shell access users on systems with STIG compliance enabled, see the FireSIGHT System STIG Release Notes. For more information on password settings for the system password for LOM users, see Enabling Lights-Out Management User Access.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1336903]To change a user’s password:
 
     [bookmark: pgfId-4754941]Access: Admin
 
     
 
     [bookmark: pgfId-5900108]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-4493661]The User Management page appears. 
 ). 
     
 
     [bookmark: pgfId-1337064]The Edit User page appears.
 
     [bookmark: pgfId-5677040]Step 3 In the Password field, type the new password (up to 32 alphanumeric characters).
 
     [bookmark: pgfId-1337356]Step 4 In the Confirm Password field, retype the new password.
 
     [bookmark: pgfId-1337383]If password strength checking is enabled for the user account, the password must have at least eight alphanumeric characters of mixed case, with at least one number and one special character. It cannot be a word that appears in a dictionary or contain consecutive repeating characters.
 
     [bookmark: pgfId-1337415]Step 5 Make any other changes you want to make to the user configuration:
 
      
       
       	 [bookmark: pgfId-4808433]For more information on password options, see Managing User Login Settings.
 
       	 [bookmark: pgfId-4808449]For more information on user roles, see Configuring User Roles.
 
      
 
     
 
     [bookmark: pgfId-4808428]Step 6 Click Save.
 
     [bookmark: pgfId-1337432]The password is changed and any other changes saved.
 
     [bookmark: pgfId-6285313]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1328637][bookmark: 57541]Deleting Us[bookmark: marker-1660897]er Accounts
 
     [bookmark: pgfId-5888260]License: Any
 
     [bookmark: pgfId-5829560]You can delete user accounts from the system at any time, with the exception of the admin account, which cannot be deleted.
 
     [bookmark: pgfId-5829561]To delete a user account:
 
     [bookmark: pgfId-4754938]Access: Admin
 
     
 
     [bookmark: pgfId-5900164]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-4493666]The User Management page appears. 
 ). The account is deleted. 
     
 
     [bookmark: pgfId-6286663]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5888270][bookmark: 54695]User Account[bookmark: marker-5888269] Privileges
 
     [bookmark: pgfId-5888281]License: Any
 
     [bookmark: pgfId-5888285]The following sections provide a list of the configurable user permissions in the FireSIGHT System and the user roles that can access them. The permissions listed here follow the order of the Menu Based Permissions list that appears when you create a custom user role. Not all permissions are available on managed devices; permissions available only on the Defense Center are marked accordingly. For more information, see Managing Custom User Roles.
 
     [bookmark: pgfId-6070691]Note that because the DC500 Defense Center and Series 2 devices support restricted features sets, not all permissions are applicable to these appliances. See the Supported Access Control Capabilities by Device Model table for a summary of Series 2 appliance features.
 
     [bookmark: pgfId-5888286]For more information on the access notations used in the tables that follow and throughout this documentation, see Access Conventions. The following sections refer to the user role privileges associated with each main menu in the web-based interface:
 
      
      	 [bookmark: pgfId-5888293]Overview Menu
 
      	 [bookmark: pgfId-5888297]Analysis Menu
 
      	 [bookmark: pgfId-5888301]Policies Menu
 
      	 [bookmark: pgfId-5978593]Devices Menu
 
      	 [bookmark: pgfId-5978603]FireAMP
 
      	 [bookmark: pgfId-5904629]Devices Menu
 
      	 [bookmark: pgfId-5928552]Health Menu
 
      	 [bookmark: pgfId-5928563]System Menu
 
      	 [bookmark: pgfId-5928576]Help Menu
 
     
 
    
 
     
      [bookmark: pgfId-5904631][bookmark: 43533]Overview Menu
 
     [bookmark: pgfId-5904632]License: Any
 
     [bookmark: pgfId-6086836]The following table lists, in order, the user role privileges required to access each option in the Overview menu and whether the user role has access to the sub-permissions within. The Security Approver, Discovery Admin, Intrusion Admin, Access Admin, Network Admin, and External Database User roles have no permissions in the Overview menu.
 
     [bookmark: pgfId-5888949]
 
      
       
        
        [bookmark: pgfId-5905909]Table 61-6 [bookmark: 57631]Overview Menu 
 
        
        
         
         	 
           
           [bookmark: pgfId-5905919]Permission 
          
  
         	 
           
           [bookmark: pgfId-5905921]Admin 
          
  
         	 
           
           [bookmark: pgfId-5905923]Maint User 
          
  
         	 
           
           [bookmark: pgfId-5905925]Security Analyst 
          
  
         	 
           
           [bookmark: pgfId-5905927]Security Analyst (RO) 
          
  
        
 
         
         	[bookmark: pgfId-5905929]Dashboards
  
         	[bookmark: pgfId-5905931]yes
  
         	[bookmark: pgfId-5905933]yes
  
         	[bookmark: pgfId-5905935]yes
  
         	[bookmark: pgfId-5905937]yes
  
        
 
         
         	[bookmark: pgfId-5905939]Manage Dashboards
  
         	[bookmark: pgfId-5905941]yes
  
         	[bookmark: pgfId-5905943]no
  
         	[bookmark: pgfId-5905945]no
  
         	[bookmark: pgfId-5905947]no
  
        
 
         
         	[bookmark: pgfId-5905949]Appliance Information Widget
  
         	[bookmark: pgfId-5905951]yes
  
         	[bookmark: pgfId-5905953]yes
  
         	[bookmark: pgfId-5905955]yes
  
         	[bookmark: pgfId-5905957]yes
  
        
 
         
         	[bookmark: pgfId-5905959]Appliance Status Widget (Defense Center only)
  
         	[bookmark: pgfId-5905961]yes
  
         	[bookmark: pgfId-5905963]yes
  
         	[bookmark: pgfId-5905965]yes
  
         	[bookmark: pgfId-5905967]yes
  
        
 
         
         	[bookmark: pgfId-5905969]Correlation Events Widget
  
         	[bookmark: pgfId-5905971]yes
  
         	[bookmark: pgfId-5905973]no
  
         	[bookmark: pgfId-5905975]yes
  
         	[bookmark: pgfId-5905977]yes
  
        
 
         
         	[bookmark: pgfId-5905979]Current Interface Status Widget
  
         	[bookmark: pgfId-5905981]yes
  
         	[bookmark: pgfId-5905983]yes
  
         	[bookmark: pgfId-5905985]yes
  
         	[bookmark: pgfId-5905987]yes
  
        
 
         
         	[bookmark: pgfId-5905989]Current Sessions Widget
  
         	[bookmark: pgfId-5905991]yes
  
         	[bookmark: pgfId-5905993]no
  
         	[bookmark: pgfId-5905995]no
  
         	[bookmark: pgfId-5905997]no
  
        
 
         
         	[bookmark: pgfId-5905999]Custom Analysis Widget (Defense Center only)
  
         	[bookmark: pgfId-5906001]yes
  
         	[bookmark: pgfId-5906003]no
  
         	[bookmark: pgfId-5906005]yes
  
         	[bookmark: pgfId-5906007]yes
  
        
 
         
         	[bookmark: pgfId-5906009]Disk Usage Widget
  
         	[bookmark: pgfId-5906011]yes
  
         	[bookmark: pgfId-5906013]yes
  
         	[bookmark: pgfId-5906015]yes
  
         	[bookmark: pgfId-5906017]yes
  
        
 
         
         	[bookmark: pgfId-5906019]Interface Traffic Widget
  
         	[bookmark: pgfId-5906021]yes
  
         	[bookmark: pgfId-5906023]yes
  
         	[bookmark: pgfId-5906025]yes
  
         	[bookmark: pgfId-5906027]yes
  
        
 
         
         	[bookmark: pgfId-5906029]Intrusion Events Widget (Defense Center only)
  
         	[bookmark: pgfId-5906031]yes
  
         	[bookmark: pgfId-5906033]no
  
         	[bookmark: pgfId-5906035]yes
  
         	[bookmark: pgfId-5906037]yes
  
        
 
         
         	[bookmark: pgfId-5906039]Network Correlation Widget (Defense Center only)
  
         	[bookmark: pgfId-5906041]yes
  
         	[bookmark: pgfId-5906043]no
  
         	[bookmark: pgfId-5906045]yes
  
         	[bookmark: pgfId-5906047]yes
  
        
 
         
         	[bookmark: pgfId-5906390]Product Licensing Widget (Defense Center only)
  
         	[bookmark: pgfId-5906392]yes
  
         	[bookmark: pgfId-5906394]yes
  
         	[bookmark: pgfId-5906396]no
  
         	[bookmark: pgfId-5906398]no
  
        
 
         
         	[bookmark: pgfId-5906380]Product Updates Widget 
  
         	[bookmark: pgfId-5906382]yes
  
         	[bookmark: pgfId-5906384]yes
  
         	[bookmark: pgfId-5906386]no
  
         	[bookmark: pgfId-5906388]no
  
        
 
         
         	[bookmark: pgfId-5906370]RSS Feed Widget
  
         	[bookmark: pgfId-5906372]yes
  
         	[bookmark: pgfId-5906374]yes
  
         	[bookmark: pgfId-5906376]yes
  
         	[bookmark: pgfId-5906378]yes
  
        
 
         
         	[bookmark: pgfId-5906360]System Load Widget
  
         	[bookmark: pgfId-5906362]yes
  
         	[bookmark: pgfId-5906364]yes
  
         	[bookmark: pgfId-5906366]yes
  
         	[bookmark: pgfId-5906368]yes
  
        
 
         
         	[bookmark: pgfId-5906350]System Time Widget
  
         	[bookmark: pgfId-5906352]yes
  
         	[bookmark: pgfId-5906354]yes
  
         	[bookmark: pgfId-5906356]yes
  
         	[bookmark: pgfId-5906358]yes
  
        
 
         
         	[bookmark: pgfId-5906440]White List Events Widget (Defense Center only)
  
         	[bookmark: pgfId-5906442]yes
  
         	[bookmark: pgfId-5906444]no
  
         	[bookmark: pgfId-5906446]yes
  
         	[bookmark: pgfId-5906448]yes
  
        
 
         
         	[bookmark: pgfId-5906468]Reporting (Defense Center only)
  
         	[bookmark: pgfId-5906470]yes
  
         	[bookmark: pgfId-5906472]no
  
         	[bookmark: pgfId-5906474]yes
  
         	[bookmark: pgfId-5906476]yes
  
        
 
         
         	[bookmark: pgfId-5906458]Manage Report Templates (Defense Center only)
  
         	[bookmark: pgfId-5906460]yes
  
         	[bookmark: pgfId-5906462]no
  
         	[bookmark: pgfId-5906464]yes
  
         	[bookmark: pgfId-5906466]yes
  
        
 
         
         	[bookmark: pgfId-5906545]Summary
  
         	[bookmark: pgfId-5906547]yes
  
         	[bookmark: pgfId-5906549]no
  
         	[bookmark: pgfId-5906551]yes
  
         	[bookmark: pgfId-5906553]yes
  
        
 
         
         	[bookmark: pgfId-5906535]Intrusion Event Statistics (Defense Center only)
  
         	[bookmark: pgfId-5906537]yes
  
         	[bookmark: pgfId-5906539]no
  
         	[bookmark: pgfId-5906541]yes
  
         	[bookmark: pgfId-5906543]yes
  
        
 
         
         	[bookmark: pgfId-5906525]Intrusion Event Performance
  
         	[bookmark: pgfId-5906527]yes
  
         	[bookmark: pgfId-5906529]no
  
         	[bookmark: pgfId-5906531]no
  
         	[bookmark: pgfId-5906533]no
  
        
 
         
         	[bookmark: pgfId-5906515]Intrusion Event Graphs (Defense Center only)
  
         	[bookmark: pgfId-5906517]yes
  
         	[bookmark: pgfId-5906519]no
  
         	[bookmark: pgfId-5906521]yes
  
         	[bookmark: pgfId-5906523]yes
  
        
 
         
         	[bookmark: pgfId-5906505]Discovery Statistics (Defense Center only)
  
         	[bookmark: pgfId-5906507]yes
  
         	[bookmark: pgfId-5906509]no
  
         	[bookmark: pgfId-5906511]yes
  
         	[bookmark: pgfId-5906513]yes
  
        
 
         
         	[bookmark: pgfId-5906495]Discovery Performance (Defense Center only)
  
         	[bookmark: pgfId-5906497]yes
  
         	[bookmark: pgfId-5906499]no
  
         	[bookmark: pgfId-5906501]no
  
         	[bookmark: pgfId-5906503]no
  
        
 
         
         	[bookmark: pgfId-5906485]Connection Summary (Defense Center only)
  
         	[bookmark: pgfId-5906487]yes
  
         	[bookmark: pgfId-5906489]no
  
         	[bookmark: pgfId-5906491]yes
  
         	[bookmark: pgfId-5906493]yes
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-5888951][bookmark: 85515]Analysis Menu
 
     [bookmark: pgfId-5888962]License: Any
 
     [bookmark: pgfId-5888966]The following table lists, in order, the user role privileges required to access each option in the Analysis menu and whether the user role has access to the sub-permissions within. Permissions that appear multiple times under different headings will be listed on the table only where they first appear, except to indicate submenu headings. The Security Approver, Intrusion Admin, Access Admin, Network Admin, and External Database User roles have no permissions in the Analysis menu. The Analysis menu is only available on the Defense Center.
 
     [bookmark: pgfId-5908858]
 
      
       
        
        [bookmark: pgfId-5986830]Table 61-7 [bookmark: 29674]Analysis Menu 
 
        
        
         
         	 
           
           [bookmark: pgfId-5986842]Menu 
          
  
         	 
           
           [bookmark: pgfId-5986844]Admin 
          
  
         	 
           
           [bookmark: pgfId-5986846]Discovery Admin 
          
  
         	 
           
           [bookmark: pgfId-5986848]Maint User 
          
  
         	 
           
           [bookmark: pgfId-5986850]Security Analyst 
          
  
         	 
           
           [bookmark: pgfId-5986852]Security Analyst (RO) 
          
  
        
 
         
         	[bookmark: pgfId-5986854]Application Statistics
  
         	[bookmark: pgfId-5986856]yes
  
         	[bookmark: pgfId-5986858]no
  
         	[bookmark: pgfId-5986860]no
  
         	[bookmark: pgfId-5986862]yes
  
         	[bookmark: pgfId-5986864]yes
  
        
 
         
         	[bookmark: pgfId-6044329]Geolocation Statistics
  
         	[bookmark: pgfId-6044331]yes
  
         	[bookmark: pgfId-6044333]no
  
         	[bookmark: pgfId-6044335]no
  
         	[bookmark: pgfId-6044337]yes
  
         	[bookmark: pgfId-6044339]yes
  
        
 
         
         	[bookmark: pgfId-5986866]User Statistics
  
         	[bookmark: pgfId-5986868]yes
  
         	[bookmark: pgfId-5986870]no
  
         	[bookmark: pgfId-5986872]no
  
         	[bookmark: pgfId-5986874]yes
  
         	[bookmark: pgfId-5986876]yes
  
        
 
         
         	[bookmark: pgfId-5986878]URL Category Statistics
  
         	[bookmark: pgfId-5986880]yes
  
         	[bookmark: pgfId-5986882]no
  
         	[bookmark: pgfId-5986884]no
  
         	[bookmark: pgfId-5986886]yes
  
         	[bookmark: pgfId-5986888]yes
  
        
 
         
         	[bookmark: pgfId-5986890]URL Reputation Statistics
  
         	[bookmark: pgfId-5986892]yes
  
         	[bookmark: pgfId-5986894]no
  
         	[bookmark: pgfId-5986896]no
  
         	[bookmark: pgfId-5986898]yes
  
         	[bookmark: pgfId-5986900]yes
  
        
 
         
         	[bookmark: pgfId-6581022]SSL Statistics
  
         	[bookmark: pgfId-6581024]yes
  
         	[bookmark: pgfId-6581026]no
  
         	[bookmark: pgfId-6581028]no
  
         	[bookmark: pgfId-6581030]yes
  
         	[bookmark: pgfId-6581032]yes
  
        
 
         
         	[bookmark: pgfId-5986902]Intrusion Event Statistics by Application
  
         	[bookmark: pgfId-5986904]yes
  
         	[bookmark: pgfId-5986906]no
  
         	[bookmark: pgfId-5986908]no
  
         	[bookmark: pgfId-5986910]yes
  
         	[bookmark: pgfId-5986912]yes
  
        
 
         
         	[bookmark: pgfId-5986914]Intrusion Event Statistics by User
  
         	[bookmark: pgfId-5986916]yes
  
         	[bookmark: pgfId-5986918]no
  
         	[bookmark: pgfId-5986920]no
  
         	[bookmark: pgfId-5986922]yes
  
         	[bookmark: pgfId-5986924]yes
  
        
 
         
         	[bookmark: pgfId-6044373]Security Intelligence Category Statistics
  
         	[bookmark: pgfId-6044375]yes
  
         	[bookmark: pgfId-6044377]no
  
         	[bookmark: pgfId-6044379]no
  
         	[bookmark: pgfId-6044381]yes
  
         	[bookmark: pgfId-6044383]yes
  
        
 
         
         	[bookmark: pgfId-6581082]File Storage Statistics by Disposition
  
         	[bookmark: pgfId-6581084]yes
  
         	[bookmark: pgfId-6581086]no
  
         	[bookmark: pgfId-6581088]no
  
         	[bookmark: pgfId-6581090]yes
  
         	[bookmark: pgfId-6581092]yes
  
        
 
         
         	[bookmark: pgfId-6581070]File Storage Statistics by Type
  
         	[bookmark: pgfId-6581072]yes
  
         	[bookmark: pgfId-6581074]no
  
         	[bookmark: pgfId-6581076]no
  
         	[bookmark: pgfId-6581078]yes
  
         	[bookmark: pgfId-6581080]yes
  
        
 
         
         	[bookmark: pgfId-6581170]Dynamic File Analysis Statistics
  
         	[bookmark: pgfId-6581172]yes
  
         	[bookmark: pgfId-6581174]no
  
         	[bookmark: pgfId-6581176]no
  
         	[bookmark: pgfId-6581178]yes
  
         	[bookmark: pgfId-6581180]yes
  
        
 
         
         	[bookmark: pgfId-5986929]Context Explorer
  
         	[bookmark: pgfId-5986931]yes
  
         	[bookmark: pgfId-5986933]no
  
         	[bookmark: pgfId-5986935]no
  
         	[bookmark: pgfId-5986937]yes
  
         	[bookmark: pgfId-5986939]yes
  
        
 
         
         	[bookmark: pgfId-5986941]Connection Events
  
         	[bookmark: pgfId-5986943]yes
  
         	[bookmark: pgfId-5986945]no
  
         	[bookmark: pgfId-5986947]no
  
         	[bookmark: pgfId-5986949]yes
  
         	[bookmark: pgfId-5986951]yes
  
        
 
         
         	[bookmark: pgfId-5986953]Modify Connection Events
  
         	[bookmark: pgfId-5986955]yes
  
         	[bookmark: pgfId-5986957]no
  
         	[bookmark: pgfId-5986959]no
  
         	[bookmark: pgfId-5986961]yes
  
         	[bookmark: pgfId-5986963]no
  
        
 
         
         	[bookmark: pgfId-5986965]Connection Summary Events
  
         	[bookmark: pgfId-5986967]yes
  
         	[bookmark: pgfId-5986969]no
  
         	[bookmark: pgfId-5986971]no
  
         	[bookmark: pgfId-5986973]yes
  
         	[bookmark: pgfId-5986975]yes
  
        
 
         
         	[bookmark: pgfId-5986977]Modify Connection Summary Events
  
         	[bookmark: pgfId-5986979]yes
  
         	[bookmark: pgfId-5986981]no
  
         	[bookmark: pgfId-5986983]no
  
         	[bookmark: pgfId-5986985]yes
  
         	[bookmark: pgfId-5986987]no
  
        
 
         
         	[bookmark: pgfId-6075582]Security Intelligence Events
  
         	[bookmark: pgfId-6075584]yes
  
         	[bookmark: pgfId-6075586]no
  
         	[bookmark: pgfId-6075588]no
  
         	[bookmark: pgfId-6075590]yes
  
         	[bookmark: pgfId-6075592]yes
  
        
 
         
         	[bookmark: pgfId-6075570]Modify Security Intelligence Events
  
         	[bookmark: pgfId-6075572]yes
  
         	[bookmark: pgfId-6075574]no
  
         	[bookmark: pgfId-6075576]no
  
         	[bookmark: pgfId-6075578]yes
  
         	[bookmark: pgfId-6075580]no
  
        
 
         
         	[bookmark: pgfId-5986989]Intrusion
  
         	[bookmark: pgfId-5986991]yes
  
         	[bookmark: pgfId-5986993]no
  
         	[bookmark: pgfId-5986995]no
  
         	[bookmark: pgfId-5986997]yes
  
         	[bookmark: pgfId-5986999]yes
  
        
 
         
         	[bookmark: pgfId-5988299]Intrusion Events
  
         	[bookmark: pgfId-5988327]yes
  
         	[bookmark: pgfId-5988329]no
  
         	[bookmark: pgfId-5988331]no
  
         	[bookmark: pgfId-5988333]yes
  
         	[bookmark: pgfId-5988335]yes
  
        
 
         
         	[bookmark: pgfId-5987001]Modify Intrusion Events
  
         	[bookmark: pgfId-5987003]yes
  
         	[bookmark: pgfId-5987005]no
  
         	[bookmark: pgfId-5987007]no
  
         	[bookmark: pgfId-5987009]yes
  
         	[bookmark: pgfId-5987011]no
  
        
 
         
         	[bookmark: pgfId-6044436]View Local Rules
  
         	[bookmark: pgfId-6044438]yes
  
         	[bookmark: pgfId-6044440]no
  
         	[bookmark: pgfId-6044442]no
  
         	[bookmark: pgfId-6044444]yes
  
         	[bookmark: pgfId-6044446]yes
  
        
 
         
         	[bookmark: pgfId-5987013]Reviewed Events
  
         	[bookmark: pgfId-5987015]yes
  
         	[bookmark: pgfId-5987017]no
  
         	[bookmark: pgfId-5987019]no
  
         	[bookmark: pgfId-5987021]yes
  
         	[bookmark: pgfId-5987023]yes
  
        
 
         
         	[bookmark: pgfId-5987025]Clipboard
  
         	[bookmark: pgfId-5987027]yes
  
         	[bookmark: pgfId-5987029]no
  
         	[bookmark: pgfId-5987031]no
  
         	[bookmark: pgfId-5987033]yes
  
         	[bookmark: pgfId-5987035]yes
  
        
 
         
         	[bookmark: pgfId-5987037]Incidents
  
         	[bookmark: pgfId-5987039]yes
  
         	[bookmark: pgfId-5987041]no
  
         	[bookmark: pgfId-5987043]no
  
         	[bookmark: pgfId-5987045]yes
  
         	[bookmark: pgfId-5987047]yes
  
        
 
         
         	[bookmark: pgfId-6073556]Files
  
         	[bookmark: pgfId-6073558]yes
  
         	[bookmark: pgfId-6073560]no
  
         	[bookmark: pgfId-6073562]no
  
         	[bookmark: pgfId-6073564]yes
  
         	[bookmark: pgfId-6073566]yes
  
        
 
         
         	[bookmark: pgfId-6581509]Malware Events
  
         	[bookmark: pgfId-6581511]yes
  
         	[bookmark: pgfId-6581513]no
  
         	[bookmark: pgfId-6581515]no
  
         	[bookmark: pgfId-6581517]yes
  
         	[bookmark: pgfId-6581519]yes
  
        
 
         
         	[bookmark: pgfId-6581521]Modify Malware Events
  
         	[bookmark: pgfId-6581523]yes
  
         	[bookmark: pgfId-6581525]no
  
         	[bookmark: pgfId-6581527]no
  
         	[bookmark: pgfId-6581529]yes
  
         	[bookmark: pgfId-6581531]no
  
        
 
         
         	[bookmark: pgfId-6581649]File Events
  
         	[bookmark: pgfId-6581651]yes
  
         	[bookmark: pgfId-6581653]no
  
         	[bookmark: pgfId-6581655]no
  
         	[bookmark: pgfId-6581657]yes
  
         	[bookmark: pgfId-6581659]yes
  
        
 
         
         	[bookmark: pgfId-6581637]Modify File Events
  
         	[bookmark: pgfId-6581639]yes
  
         	[bookmark: pgfId-6581641]no
  
         	[bookmark: pgfId-6581643]no
  
         	[bookmark: pgfId-6581645]yes
  
         	[bookmark: pgfId-6581647]no
  
        
 
         
         	[bookmark: pgfId-6581777]Captured Files
  
         	[bookmark: pgfId-6581779]yes
  
         	[bookmark: pgfId-6581781]no
  
         	[bookmark: pgfId-6581783]no
  
         	[bookmark: pgfId-6581785]yes
  
         	[bookmark: pgfId-6581787]yes
  
        
 
         
         	[bookmark: pgfId-6581765]Modify Captured Files
  
         	[bookmark: pgfId-6581767]yes
  
         	[bookmark: pgfId-6581769]no
  
         	[bookmark: pgfId-6581771]no
  
         	[bookmark: pgfId-6581773]yes
  
         	[bookmark: pgfId-6581775]no
  
        
 
         
         	[bookmark: pgfId-6581326]File Trajectory
  
         	[bookmark: pgfId-6581328]yes
  
         	[bookmark: pgfId-6581330]no
  
         	[bookmark: pgfId-6581332]no
  
         	[bookmark: pgfId-6581334]yes
  
         	[bookmark: pgfId-6581336]yes
  
        
 
         
         	[bookmark: pgfId-6073583]File Download
  
         	[bookmark: pgfId-6073585]yes
  
         	[bookmark: pgfId-6073587]no
  
         	[bookmark: pgfId-6073589]no
  
         	[bookmark: pgfId-6073591]yes
  
         	[bookmark: pgfId-6073593]yes
  
        
 
         
         	[bookmark: pgfId-6073595]Dynamic File Analysis
  
         	[bookmark: pgfId-6073597]yes
  
         	[bookmark: pgfId-6073599]no
  
         	[bookmark: pgfId-6073601]no
  
         	[bookmark: pgfId-6073603]yes
  
         	[bookmark: pgfId-6073605]no
  
        
 
         
         	[bookmark: pgfId-5987073]Hosts
  
         	[bookmark: pgfId-5987075]yes
  
         	[bookmark: pgfId-5987077]no
  
         	[bookmark: pgfId-5987079]no
  
         	[bookmark: pgfId-5987081]yes
  
         	[bookmark: pgfId-5987083]yes
  
        
 
         
         	[bookmark: pgfId-5987085]Network Map
  
         	[bookmark: pgfId-5987087]yes
  
         	[bookmark: pgfId-5987089]no
  
         	[bookmark: pgfId-5987091]no
  
         	[bookmark: pgfId-5987093]yes
  
         	[bookmark: pgfId-5987095]yes
  
        
 
         
         	[bookmark: pgfId-5987097]Hosts
  
         	[bookmark: pgfId-5987099]yes
  
         	[bookmark: pgfId-5987101]no
  
         	[bookmark: pgfId-5987103]no
  
         	[bookmark: pgfId-5987105]yes
  
         	[bookmark: pgfId-5987107]yes
  
        
 
         
         	[bookmark: pgfId-5987109]Modify Hosts
  
         	[bookmark: pgfId-5987111]yes
  
         	[bookmark: pgfId-5987113]no
  
         	[bookmark: pgfId-5987115]no
  
         	[bookmark: pgfId-5987117]yes
  
         	[bookmark: pgfId-5987119]no
  
        
 
         
         	[bookmark: pgfId-6083486]Indications of Compromise
  
         	[bookmark: pgfId-6083488]yes
  
         	[bookmark: pgfId-6083490]no
  
         	[bookmark: pgfId-6083492]no
  
         	[bookmark: pgfId-6083494]yes
  
         	[bookmark: pgfId-6083496]yes
  
        
 
         
         	[bookmark: pgfId-6083474]Modify Indications of Compromise
  
         	[bookmark: pgfId-6083476]yes
  
         	[bookmark: pgfId-6083478]no
  
         	[bookmark: pgfId-6083480]no
  
         	[bookmark: pgfId-6083482]yes
  
         	[bookmark: pgfId-6083484]no
  
        
 
         
         	[bookmark: pgfId-5987133]Servers
  
         	[bookmark: pgfId-5987135]yes
  
         	[bookmark: pgfId-5987137]no
  
         	[bookmark: pgfId-5987139]no
  
         	[bookmark: pgfId-5987141]yes
  
         	[bookmark: pgfId-5987143]yes
  
        
 
         
         	[bookmark: pgfId-5987145]Modify Servers
  
         	[bookmark: pgfId-5987147]yes
  
         	[bookmark: pgfId-5987149]no
  
         	[bookmark: pgfId-5987151]no
  
         	[bookmark: pgfId-5987153]yes
  
         	[bookmark: pgfId-5987155]no
  
        
 
         
         	[bookmark: pgfId-5987157]Vulnerabilities
  
         	[bookmark: pgfId-5987159]yes
  
         	[bookmark: pgfId-5987161]no
  
         	[bookmark: pgfId-5987163]no
  
         	[bookmark: pgfId-5987165]yes
  
         	[bookmark: pgfId-5987167]yes
  
        
 
         
         	[bookmark: pgfId-6581899]Modify Vulnerabilities
  
         	[bookmark: pgfId-6581901]yes
  
         	[bookmark: pgfId-6581903]no
  
         	[bookmark: pgfId-6581905]no
  
         	[bookmark: pgfId-6581907]yes
  
         	[bookmark: pgfId-6581909]no
  
        
 
         
         	[bookmark: pgfId-5987169]Host Attributes
  
         	[bookmark: pgfId-5987171]yes
  
         	[bookmark: pgfId-5987173]no
  
         	[bookmark: pgfId-5987175]no
  
         	[bookmark: pgfId-5987177]yes
  
         	[bookmark: pgfId-5987179]yes
  
        
 
         
         	[bookmark: pgfId-5987181]Modify Host Attributes
  
         	[bookmark: pgfId-5987183]yes
  
         	[bookmark: pgfId-5987185]no
  
         	[bookmark: pgfId-5987187]no
  
         	[bookmark: pgfId-5987189]yes
  
         	[bookmark: pgfId-5987191]no
  
        
 
         
         	[bookmark: pgfId-5987193]Applications
  
         	[bookmark: pgfId-5987195]yes
  
         	[bookmark: pgfId-5987197]no
  
         	[bookmark: pgfId-5987199]no
  
         	[bookmark: pgfId-5987201]yes
  
         	[bookmark: pgfId-5987203]yes
  
        
 
         
         	[bookmark: pgfId-5997000]Application Details
  
         	[bookmark: pgfId-5997002]yes
  
         	[bookmark: pgfId-5997004]no
  
         	[bookmark: pgfId-5997006]no
  
         	[bookmark: pgfId-5997008]yes
  
         	[bookmark: pgfId-5997010]yes
  
        
 
         
         	[bookmark: pgfId-5997012]Modify Application Details
  
         	[bookmark: pgfId-5997014]yes
  
         	[bookmark: pgfId-5997016]no
  
         	[bookmark: pgfId-5997018]no
  
         	[bookmark: pgfId-5997020]yes
  
         	[bookmark: pgfId-5997022]no
  
        
 
         
         	[bookmark: pgfId-5987229]Host Attribute Management
  
         	[bookmark: pgfId-5987231]yes
  
         	[bookmark: pgfId-5987233]no
  
         	[bookmark: pgfId-5987235]no
  
         	[bookmark: pgfId-5987237]no
  
         	[bookmark: pgfId-5987239]no
  
        
 
         
         	[bookmark: pgfId-5987241]Discovery Events
  
         	[bookmark: pgfId-5987243]yes
  
         	[bookmark: pgfId-5987245]no
  
         	[bookmark: pgfId-5987247]no
  
         	[bookmark: pgfId-5987249]yes
  
         	[bookmark: pgfId-5987251]yes
  
        
 
         
         	[bookmark: pgfId-5987253]Modify Discovery Events
  
         	[bookmark: pgfId-5987255]yes
  
         	[bookmark: pgfId-5987257]no
  
         	[bookmark: pgfId-5987259]no
  
         	[bookmark: pgfId-5987261]yes
  
         	[bookmark: pgfId-5987263]no
  
        
 
         
         	[bookmark: pgfId-5987265]Users
  
         	[bookmark: pgfId-5987267]yes
  
         	[bookmark: pgfId-5987269]yes
  
         	[bookmark: pgfId-5987271]no
  
         	[bookmark: pgfId-5987273]yes
  
         	[bookmark: pgfId-5987275]yes
  
        
 
         
         	[bookmark: pgfId-5987277]User Activity
  
         	[bookmark: pgfId-5987279]yes
  
         	[bookmark: pgfId-5987281]yes
  
         	[bookmark: pgfId-5987283]no
  
         	[bookmark: pgfId-5987285]yes
  
         	[bookmark: pgfId-5987287]yes
  
        
 
         
         	[bookmark: pgfId-5987289]Modify User Activity Events
  
         	[bookmark: pgfId-5987291]yes
  
         	[bookmark: pgfId-5987293]yes
  
         	[bookmark: pgfId-5987295]no
  
         	[bookmark: pgfId-5987297]yes
  
         	[bookmark: pgfId-5987299]no
  
        
 
         
         	[bookmark: pgfId-5987301]Users
  
         	[bookmark: pgfId-5987303]yes
  
         	[bookmark: pgfId-5987305]yes
  
         	[bookmark: pgfId-5987307]no
  
         	[bookmark: pgfId-5987309]yes
  
         	[bookmark: pgfId-5987311]yes
  
        
 
         
         	[bookmark: pgfId-5987313]Modify Users
  
         	[bookmark: pgfId-5987315]yes
  
         	[bookmark: pgfId-5987317]yes
  
         	[bookmark: pgfId-5987319]no
  
         	[bookmark: pgfId-5987321]yes
  
         	[bookmark: pgfId-5987323]no
  
        
 
         
         	[bookmark: pgfId-5987325]Vulnerabilities
  
         	[bookmark: pgfId-5987327]yes
  
         	[bookmark: pgfId-5987329]no
  
         	[bookmark: pgfId-5987331]no
  
         	[bookmark: pgfId-5987333]yes
  
         	[bookmark: pgfId-5987335]yes
  
        
 
         
         	[bookmark: pgfId-5987337]Third-party Vulnerabilities
  
         	[bookmark: pgfId-5987339]yes
  
         	[bookmark: pgfId-5987341]no
  
         	[bookmark: pgfId-5987343]no
  
         	[bookmark: pgfId-5987345]yes
  
         	[bookmark: pgfId-5987347]yes
  
        
 
         
         	[bookmark: pgfId-5987349]Modify Third-party Vulnerabilities
  
         	[bookmark: pgfId-5987351]yes
  
         	[bookmark: pgfId-5987353]no
  
         	[bookmark: pgfId-5987355]no
  
         	[bookmark: pgfId-5987357]yes
  
         	[bookmark: pgfId-5987359]no
  
        
 
         
         	[bookmark: pgfId-5987361]Correlation
  
         	[bookmark: pgfId-5987363]yes
  
         	[bookmark: pgfId-5987365]yes
  
         	[bookmark: pgfId-5987367]no
  
         	[bookmark: pgfId-5987369]yes
  
         	[bookmark: pgfId-5987371]yes
  
        
 
         
         	[bookmark: pgfId-5987373]Correlation Events
  
         	[bookmark: pgfId-5987375]yes
  
         	[bookmark: pgfId-5987377]yes
  
         	[bookmark: pgfId-5987379]no
  
         	[bookmark: pgfId-5987381]yes
  
         	[bookmark: pgfId-5987383]yes
  
        
 
         
         	[bookmark: pgfId-5987385]Modify Correlation Events
  
         	[bookmark: pgfId-5987387]yes
  
         	[bookmark: pgfId-5987389]yes
  
         	[bookmark: pgfId-5987391]no
  
         	[bookmark: pgfId-5987393]yes
  
         	[bookmark: pgfId-5987395]no
  
        
 
         
         	[bookmark: pgfId-5987397]White List Events
  
         	[bookmark: pgfId-5987399]yes
  
         	[bookmark: pgfId-5987401]yes
  
         	[bookmark: pgfId-5987403]no
  
         	[bookmark: pgfId-5987405]yes
  
         	[bookmark: pgfId-5987407]yes
  
        
 
         
         	[bookmark: pgfId-5987409]Modify White List Events
  
         	[bookmark: pgfId-5987411]yes
  
         	[bookmark: pgfId-5987413]yes
  
         	[bookmark: pgfId-5987415]no
  
         	[bookmark: pgfId-5987417]yes
  
         	[bookmark: pgfId-5987419]no
  
        
 
         
         	[bookmark: pgfId-5987421]White List Violations
  
         	[bookmark: pgfId-5987423]yes
  
         	[bookmark: pgfId-5987425]yes
  
         	[bookmark: pgfId-5987427]no
  
         	[bookmark: pgfId-5987429]yes
  
         	[bookmark: pgfId-5987431]yes
  
        
 
         
         	[bookmark: pgfId-5987433]Remediation Status
  
         	[bookmark: pgfId-5987435]yes
  
         	[bookmark: pgfId-5987437]yes
  
         	[bookmark: pgfId-5987439]no
  
         	[bookmark: pgfId-5987441]no
  
         	[bookmark: pgfId-5987443]no
  
        
 
         
         	[bookmark: pgfId-5987445]Modify Remediation Status
  
         	[bookmark: pgfId-5987447]yes
  
         	[bookmark: pgfId-5987449]yes
  
         	[bookmark: pgfId-5987451]no
  
         	[bookmark: pgfId-5987453]no
  
         	[bookmark: pgfId-5987455]no
  
        
 
         
         	[bookmark: pgfId-5987457]Custom
  
         	[bookmark: pgfId-5987459]yes
  
         	[bookmark: pgfId-5987461]no
  
         	[bookmark: pgfId-5987463]no
  
         	[bookmark: pgfId-5987465]yes
  
         	[bookmark: pgfId-5987467]yes
  
        
 
         
         	[bookmark: pgfId-5987469]Custom Workflows
  
         	[bookmark: pgfId-5987471]yes
  
         	[bookmark: pgfId-5987473]no
  
         	[bookmark: pgfId-5987475]no
  
         	[bookmark: pgfId-5987477]yes
  
         	[bookmark: pgfId-5987479]yes
  
        
 
         
         	[bookmark: pgfId-5987481]Manage Custom Workflows
  
         	[bookmark: pgfId-5987483]yes
  
         	[bookmark: pgfId-5987485]no
  
         	[bookmark: pgfId-5987487]no
  
         	[bookmark: pgfId-5987489]yes
  
         	[bookmark: pgfId-5987491]yes
  
        
 
         
         	[bookmark: pgfId-5987493]Custom Tables
  
         	[bookmark: pgfId-5987495]yes
  
         	[bookmark: pgfId-5987497]no
  
         	[bookmark: pgfId-5987499]no
  
         	[bookmark: pgfId-5987501]yes
  
         	[bookmark: pgfId-5987503]yes
  
        
 
         
         	[bookmark: pgfId-5987505]Manage Custom Tables
  
         	[bookmark: pgfId-5987507]yes
  
         	[bookmark: pgfId-5987509]no
  
         	[bookmark: pgfId-5987511]no
  
         	[bookmark: pgfId-5987513]yes
  
         	[bookmark: pgfId-5987515]yes
  
        
 
         
         	[bookmark: pgfId-5987517]Search
  
         	[bookmark: pgfId-5987519]yes
  
         	[bookmark: pgfId-5987521]no
  
         	[bookmark: pgfId-5987523]yes
  
         	[bookmark: pgfId-5987525]yes
  
         	[bookmark: pgfId-5987527]yes
  
        
 
         
         	[bookmark: pgfId-5987529]Manage Search
  
         	[bookmark: pgfId-5987531]yes
  
         	[bookmark: pgfId-5987533]no
  
         	[bookmark: pgfId-5987535]no
  
         	[bookmark: pgfId-5987537]no
  
         	[bookmark: pgfId-5987539]no
  
        
 
         
         	[bookmark: pgfId-5987592]Bookmarks
  
         	[bookmark: pgfId-5987594]yes
  
         	[bookmark: pgfId-5987596]no
  
         	[bookmark: pgfId-5987598]no
  
         	[bookmark: pgfId-5987600]yes
  
         	[bookmark: pgfId-5987602]yes
  
        
 
         
         	[bookmark: pgfId-5987604]Manage Bookmarks
  
         	[bookmark: pgfId-5987606]yes
  
         	[bookmark: pgfId-5987608]no
  
         	[bookmark: pgfId-5987610]no
  
         	[bookmark: pgfId-5987612]yes
  
         	[bookmark: pgfId-5987614]yes
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-5908860][bookmark: 71562]Policies Menu 
 
     [bookmark: pgfId-5908943]License: Any
 
     [bookmark: pgfId-5909474]The following table lists, in order, the user role privileges required to access each option in the Policies menu and whether the user roles has access to the sub-permissions within. The External Database User, Maintenance User, Security Analyst, and Security Analyst (Read Only) roles have no permissions in the Policies menu. The Policies menu is only available on the Defense Center.
 
     [bookmark: pgfId-6594661]Note that the Intrusion Policy and Modify Intrusion Policy privileges also allow you to create and modify network analysis policies.
 
     [bookmark: pgfId-5909460]
 
      
       
        
        [bookmark: pgfId-5926545]Table 61-8 [bookmark: 43967]Policies Menu 
 
        
        
         
         	 
           
           [bookmark: pgfId-5926559]Menu 
          
  
         	 
           
           [bookmark: pgfId-5926561]Access Admin 
          
  
         	 
           
           [bookmark: pgfId-5926563]Admin 
          
  
         	 
           
           [bookmark: pgfId-5926565]Discovery Admin 
          
  
         	 
           
           [bookmark: pgfId-5926567]Intrusion Admin 
          
  
         	 
           
           [bookmark: pgfId-5926569]Network Admin 
          
  
         	 
           
           [bookmark: pgfId-5926571]Security Approver 
          
  
        
 
         
         	[bookmark: pgfId-5926573]Access Control
  
         	[bookmark: pgfId-5926575]yes
  
         	[bookmark: pgfId-5926577]yes
  
         	[bookmark: pgfId-5926579]no
  
         	[bookmark: pgfId-5926581]no
  
         	[bookmark: pgfId-5926583]yes
  
         	[bookmark: pgfId-5926585]yes
  
        
 
         
         	[bookmark: pgfId-5926587]Access Control List
  
         	[bookmark: pgfId-5926589]yes
  
         	[bookmark: pgfId-5926591]yes
  
         	[bookmark: pgfId-5926593]no
  
         	[bookmark: pgfId-5926595]no
  
         	[bookmark: pgfId-5926597]yes
  
         	[bookmark: pgfId-5926599]yes
  
        
 
         
         	[bookmark: pgfId-5926601]Modify Access Control Policy
  
         	[bookmark: pgfId-5926603]yes
  
         	[bookmark: pgfId-5926605]yes
  
         	[bookmark: pgfId-5926607]no
  
         	[bookmark: pgfId-5926609]no
  
         	[bookmark: pgfId-5926611]yes
  
         	[bookmark: pgfId-5926613]no
  
        
 
         
         	[bookmark: pgfId-5926615]Modify Administrator Rules
  
         	[bookmark: pgfId-5926617]yes
  
         	[bookmark: pgfId-5926619]yes
  
         	[bookmark: pgfId-5926621]no
  
         	[bookmark: pgfId-5926623]no
  
         	[bookmark: pgfId-5926625]yes
  
         	[bookmark: pgfId-5926627]no
  
        
 
         
         	[bookmark: pgfId-5926629]Modify Root Rules
  
         	[bookmark: pgfId-5926631]yes
  
         	[bookmark: pgfId-5926633]yes
  
         	[bookmark: pgfId-5926635]no
  
         	[bookmark: pgfId-5926637]no
  
         	[bookmark: pgfId-5926639]yes
  
         	[bookmark: pgfId-5926641]no
  
        
 
         
         	[bookmark: pgfId-5926643]Apply Intrusion Policies
  
         	[bookmark: pgfId-5926645]no
  
         	[bookmark: pgfId-5926647]yes
  
         	[bookmark: pgfId-5926649]no
  
         	[bookmark: pgfId-5926651]no
  
         	[bookmark: pgfId-5926653]no
  
         	[bookmark: pgfId-5926655]yes
  
        
 
         
         	[bookmark: pgfId-5926657]Apply Access Control Policies
  
         	[bookmark: pgfId-5926659]no
  
         	[bookmark: pgfId-5926661]yes
  
         	[bookmark: pgfId-5926663]no
  
         	[bookmark: pgfId-5926665]no
  
         	[bookmark: pgfId-5926667]no
  
         	[bookmark: pgfId-5926669]yes
  
        
 
         
         	[bookmark: pgfId-5926671]Intrusion
  
         	[bookmark: pgfId-5926673]yes
  
         	[bookmark: pgfId-5926675]yes
  
         	[bookmark: pgfId-5926677]no
  
         	[bookmark: pgfId-5926679]yes
  
         	[bookmark: pgfId-5926681]no
  
         	[bookmark: pgfId-5926683]yes
  
        
 
         
         	[bookmark: pgfId-5926685]Intrusion Policy
  
         	[bookmark: pgfId-5926687]no
  
         	[bookmark: pgfId-5926689]yes
  
         	[bookmark: pgfId-5926691]no
  
         	[bookmark: pgfId-5926693]yes
  
         	[bookmark: pgfId-5926695]no
  
         	[bookmark: pgfId-5926697]yes
  
        
 
         
         	[bookmark: pgfId-5926713]Rule Editor
  
         	[bookmark: pgfId-5926715]no
  
         	[bookmark: pgfId-5926717]yes
  
         	[bookmark: pgfId-5926719]no
  
         	[bookmark: pgfId-5926721]yes
  
         	[bookmark: pgfId-5926723]no
  
         	[bookmark: pgfId-5926725]no
  
        
 
         
         	[bookmark: pgfId-5926783]Email
  
         	[bookmark: pgfId-5926785]no
  
         	[bookmark: pgfId-5926787]yes
  
         	[bookmark: pgfId-5926789]no
  
         	[bookmark: pgfId-5926791]yes
  
         	[bookmark: pgfId-5926793]no
  
         	[bookmark: pgfId-5926795]no
  
        
 
         
         	[bookmark: pgfId-6193663]Modify Intrusion Policy
  
         	[bookmark: pgfId-6193665]no
  
         	[bookmark: pgfId-6193667]yes
  
         	[bookmark: pgfId-6193669]no
  
         	[bookmark: pgfId-6193671]yes
  
         	[bookmark: pgfId-6193673]no
  
         	[bookmark: pgfId-6193675]no
  
        
 
         
         	[bookmark: pgfId-6011286]File Policy
  
         	[bookmark: pgfId-6011288]yes
  
         	[bookmark: pgfId-6011290]yes
  
         	[bookmark: pgfId-6011292]no
  
         	[bookmark: pgfId-6011294]no
  
         	[bookmark: pgfId-6011296]no
  
         	[bookmark: pgfId-6011298]no
  
        
 
         
         	[bookmark: pgfId-6011312]Modify File Policy
  
         	[bookmark: pgfId-6011314]yes
  
         	[bookmark: pgfId-6011316]yes
  
         	[bookmark: pgfId-6011318]no
  
         	[bookmark: pgfId-6011320]no
  
         	[bookmark: pgfId-6011322]no
  
         	[bookmark: pgfId-6011324]no
  
        
 
         
         	[bookmark: pgfId-5926811]Network Discovery
  
         	[bookmark: pgfId-5926813]no
  
         	[bookmark: pgfId-5926815]yes
  
         	[bookmark: pgfId-5926817]yes
  
         	[bookmark: pgfId-5926819]no
  
         	[bookmark: pgfId-5926821]no
  
         	[bookmark: pgfId-5926823]yes
  
        
 
         
         	[bookmark: pgfId-5926853]Custom Fingerprinting
  
         	[bookmark: pgfId-5926855]no
  
         	[bookmark: pgfId-5926857]yes
  
         	[bookmark: pgfId-5926859]yes
  
         	[bookmark: pgfId-5926861]no
  
         	[bookmark: pgfId-5926863]no
  
         	[bookmark: pgfId-5926865]no
  
        
 
         
         	[bookmark: pgfId-5926895]Custom Topology
  
         	[bookmark: pgfId-5926897]no
  
         	[bookmark: pgfId-5926899]yes
  
         	[bookmark: pgfId-5926901]yes
  
         	[bookmark: pgfId-5926903]no
  
         	[bookmark: pgfId-5926905]no
  
         	[bookmark: pgfId-5926907]no
  
        
 
         
         	[bookmark: pgfId-6582124]Modify Network Discovery
  
         	[bookmark: pgfId-6582126]no
  
         	[bookmark: pgfId-6582128]yes
  
         	[bookmark: pgfId-6582130]yes
  
         	[bookmark: pgfId-6582132]no
  
         	[bookmark: pgfId-6582134]no
  
         	[bookmark: pgfId-6582136]no
  
        
 
         
         	[bookmark: pgfId-6582110]Apply Network Discovery
  
         	[bookmark: pgfId-6582112]no
  
         	[bookmark: pgfId-6582114]yes
  
         	[bookmark: pgfId-6582116]no
  
         	[bookmark: pgfId-6582118]no
  
         	[bookmark: pgfId-6582120]no
  
         	[bookmark: pgfId-6582122]yes
  
        
 
         
         	[bookmark: pgfId-6156740]SSL
  
         	[bookmark: pgfId-6156742]yes
  
         	[bookmark: pgfId-6156744]yes
  
         	[bookmark: pgfId-6156746]no
  
         	[bookmark: pgfId-6156748]no
  
         	[bookmark: pgfId-6156750]yes
  
         	[bookmark: pgfId-6156752]yes
  
        
 
         
         	[bookmark: pgfId-6187153]Modify SSL Policy
  
         	[bookmark: pgfId-6187077]yes
  
         	[bookmark: pgfId-6187079]yes
  
         	[bookmark: pgfId-6187081]no
  
         	[bookmark: pgfId-6187083]no
  
         	[bookmark: pgfId-6187085]yes
  
         	[bookmark: pgfId-6187087]no
  
        
 
         
         	[bookmark: pgfId-6187159]Modify Administrator Rules
  
         	[bookmark: pgfId-6187091]yes
  
         	[bookmark: pgfId-6187093]yes
  
         	[bookmark: pgfId-6187095]no
  
         	[bookmark: pgfId-6187097]no
  
         	[bookmark: pgfId-6187099]yes
  
         	[bookmark: pgfId-6187101]no
  
        
 
         
         	[bookmark: pgfId-6187165]Modify Root Rules
  
         	[bookmark: pgfId-6187105]yes
  
         	[bookmark: pgfId-6187107]yes
  
         	[bookmark: pgfId-6187109]no
  
         	[bookmark: pgfId-6187111]no
  
         	[bookmark: pgfId-6187113]yes
  
         	[bookmark: pgfId-6187115]no
  
        
 
         
         	[bookmark: pgfId-6187171]Apply SSL Policy
  
         	[bookmark: pgfId-6187119]no
  
         	[bookmark: pgfId-6187121]yes
  
         	[bookmark: pgfId-6187123]no
  
         	[bookmark: pgfId-6187125]no
  
         	[bookmark: pgfId-6187127]no
  
         	[bookmark: pgfId-6187129]yes
  
        
 
         
         	[bookmark: pgfId-6044478]Application Detectors
  
         	[bookmark: pgfId-6044480]no
  
         	[bookmark: pgfId-6044482]yes
  
         	[bookmark: pgfId-6044484]yes
  
         	[bookmark: pgfId-6044486]no
  
         	[bookmark: pgfId-6044488]no
  
         	[bookmark: pgfId-6044490]no
  
        
 
         
         	[bookmark: pgfId-6193627]User 3rd Party Mappings
  
         	[bookmark: pgfId-6193629]no
  
         	[bookmark: pgfId-6193631]yes
  
         	[bookmark: pgfId-6193633]yes
  
         	[bookmark: pgfId-6193635]no
  
         	[bookmark: pgfId-6193637]no
  
         	[bookmark: pgfId-6193639]no
  
        
 
         
         	[bookmark: pgfId-6193609]Custom Product Mappings
  
         	[bookmark: pgfId-6193611]no
  
         	[bookmark: pgfId-6193613]yes
  
         	[bookmark: pgfId-6193615]yes
  
         	[bookmark: pgfId-6193617]no
  
         	[bookmark: pgfId-6193619]no
  
         	[bookmark: pgfId-6193621]no
  
        
 
         
         	[bookmark: pgfId-5927049]Users
  
         	[bookmark: pgfId-5927051]no
  
         	[bookmark: pgfId-5927053]yes
  
         	[bookmark: pgfId-5927055]no
  
         	[bookmark: pgfId-5927057]no
  
         	[bookmark: pgfId-5927059]no
  
         	[bookmark: pgfId-5927061]no
  
        
 
         
         	[bookmark: pgfId-5927063]Correlation
  
         	[bookmark: pgfId-5927065]no
  
         	[bookmark: pgfId-5927067]yes
  
         	[bookmark: pgfId-5927069]no
  
         	[bookmark: pgfId-5927071]no
  
         	[bookmark: pgfId-5927073]no
  
         	[bookmark: pgfId-5927075]no
  
        
 
         
         	[bookmark: pgfId-5927077]Policy Management
  
         	[bookmark: pgfId-5927079]no
  
         	[bookmark: pgfId-5927081]yes
  
         	[bookmark: pgfId-5927083]no
  
         	[bookmark: pgfId-5927085]no
  
         	[bookmark: pgfId-5927087]no
  
         	[bookmark: pgfId-5927089]no
  
        
 
         
         	[bookmark: pgfId-5927091]Rule Management
  
         	[bookmark: pgfId-5927093]no
  
         	[bookmark: pgfId-5927095]yes
  
         	[bookmark: pgfId-5927097]no
  
         	[bookmark: pgfId-5927099]no
  
         	[bookmark: pgfId-5927101]no
  
         	[bookmark: pgfId-5927103]no
  
        
 
         
         	[bookmark: pgfId-5927105]White List
  
         	[bookmark: pgfId-5927107]no
  
         	[bookmark: pgfId-5927109]yes
  
         	[bookmark: pgfId-5927111]no
  
         	[bookmark: pgfId-5927113]no
  
         	[bookmark: pgfId-5927115]no
  
         	[bookmark: pgfId-5927117]no
  
        
 
         
         	[bookmark: pgfId-5927119]Traffic Profiles
  
         	[bookmark: pgfId-5927121]no
  
         	[bookmark: pgfId-5927123]yes
  
         	[bookmark: pgfId-5927125]no
  
         	[bookmark: pgfId-5927127]no
  
         	[bookmark: pgfId-5927129]no
  
         	[bookmark: pgfId-5927131]no
  
        
 
         
         	[bookmark: pgfId-5927133]Actions
  
         	[bookmark: pgfId-5927135]no
  
         	[bookmark: pgfId-5927137]yes
  
         	[bookmark: pgfId-5927139]yes
  
         	[bookmark: pgfId-5927141]no
  
         	[bookmark: pgfId-5927143]no
  
         	[bookmark: pgfId-5927145]no
  
        
 
         
         	[bookmark: pgfId-5927147]Alerts
  
         	[bookmark: pgfId-5927149]no
  
         	[bookmark: pgfId-5927151]yes
  
         	[bookmark: pgfId-5927153]yes
  
         	[bookmark: pgfId-5927155]no
  
         	[bookmark: pgfId-5927157]no
  
         	[bookmark: pgfId-5927159]no
  
        
 
         
         	[bookmark: pgfId-5927161]Impact Flag Alerts
  
         	[bookmark: pgfId-5927163]no
  
         	[bookmark: pgfId-5927165]yes
  
         	[bookmark: pgfId-5927167]yes
  
         	[bookmark: pgfId-5927169]no
  
         	[bookmark: pgfId-5927171]no
  
         	[bookmark: pgfId-5927173]no
  
        
 
         
         	[bookmark: pgfId-5927175]Discovery Event Alerts
  
         	[bookmark: pgfId-5927177]no
  
         	[bookmark: pgfId-5927179]yes
  
         	[bookmark: pgfId-5927181]yes
  
         	[bookmark: pgfId-5927183]no
  
         	[bookmark: pgfId-5927185]no
  
         	[bookmark: pgfId-5927187]no
  
        
 
         
         	[bookmark: pgfId-5927189]Scanners
  
         	[bookmark: pgfId-5927191]no
  
         	[bookmark: pgfId-5927193]yes
  
         	[bookmark: pgfId-5927195]yes
  
         	[bookmark: pgfId-5927197]no
  
         	[bookmark: pgfId-5927199]no
  
         	[bookmark: pgfId-5927201]no
  
        
 
         
         	[bookmark: pgfId-5927203]Scan Results
  
         	[bookmark: pgfId-5927205]no
  
         	[bookmark: pgfId-5927207]yes
  
         	[bookmark: pgfId-5927209]yes
  
         	[bookmark: pgfId-5927211]no
  
         	[bookmark: pgfId-5927213]no
  
         	[bookmark: pgfId-5927215]no
  
        
 
         
         	[bookmark: pgfId-5927217]Modify Scan Results
  
         	[bookmark: pgfId-5927219]no
  
         	[bookmark: pgfId-5927221]yes
  
         	[bookmark: pgfId-5927223]yes
  
         	[bookmark: pgfId-5927225]no
  
         	[bookmark: pgfId-5927227]no
  
         	[bookmark: pgfId-5927229]no
  
        
 
         
         	[bookmark: pgfId-5927231]Groups
  
         	[bookmark: pgfId-5927233]no
  
         	[bookmark: pgfId-5927235]yes
  
         	[bookmark: pgfId-5927237]no
  
         	[bookmark: pgfId-5927239]no
  
         	[bookmark: pgfId-5927241]no
  
         	[bookmark: pgfId-5927243]no
  
        
 
         
         	[bookmark: pgfId-5927245]Modules
  
         	[bookmark: pgfId-5927247]no
  
         	[bookmark: pgfId-5927249]yes
  
         	[bookmark: pgfId-5927251]no
  
         	[bookmark: pgfId-5927253]no
  
         	[bookmark: pgfId-5927255]no
  
         	[bookmark: pgfId-5927257]no
  
        
 
         
         	[bookmark: pgfId-5927259]Instances
  
         	[bookmark: pgfId-5927261]no
  
         	[bookmark: pgfId-5927263]yes
  
         	[bookmark: pgfId-5927265]no
  
         	[bookmark: pgfId-5927267]no
  
         	[bookmark: pgfId-5927269]no
  
         	[bookmark: pgfId-5927271]no
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-6044693][bookmark: 20063][bookmark: 96953]Devices Menu
 
     [bookmark: pgfId-6044694]License: Any
 
     [bookmark: pgfId-6260617]The Devices menu table lists, in order, the user role privileges required to access each option in the Devices menu and the sub-permissions within. An X indicates that the user role has access. The Access Admin, Discovery Admin, External Database User, Intrusion Admin, Maintenance User, Security Approver, Security Analyst, and Security Analyst (Read Only) have no permissions in the Devices menu. The Devices menu is only available on the Defense Center.
 
     [bookmark: pgfId-6260817]
 
      
       
        
        [bookmark: pgfId-6260909]Table 61-9 Devices Menu 
 
        
        
         
         	 
           
           [bookmark: pgfId-6260915]Menu 
          
  
         	 
           
           [bookmark: pgfId-6260917]Admin 
          
  
         	 
           
           [bookmark: pgfId-6260919]Network Admin 
          
  
        
 
         
         	[bookmark: pgfId-6260921]Device Management
  
         	[bookmark: pgfId-6260923]yes
  
         	[bookmark: pgfId-6260925]yes
  
        
 
         
         	[bookmark: pgfId-6260927]Modify Devices
  
         	[bookmark: pgfId-6260929]yes
  
         	[bookmark: pgfId-6260931]yes
  
        
 
         
         	[bookmark: pgfId-6260933]Apply Device Changes
  
         	[bookmark: pgfId-6260935]yes
  
         	[bookmark: pgfId-6260937]yes
  
        
 
         
         	[bookmark: pgfId-6260939]NAT
  
         	[bookmark: pgfId-6260941]yes
  
         	[bookmark: pgfId-6260943]yes
  
        
 
         
         	[bookmark: pgfId-6260945]NAT List
  
         	[bookmark: pgfId-6260947]yes
  
         	[bookmark: pgfId-6260949]yes
  
        
 
         
         	[bookmark: pgfId-6260951]Modify NAT Policy
  
         	[bookmark: pgfId-6260953]yes
  
         	[bookmark: pgfId-6260955]yes
  
        
 
         
         	[bookmark: pgfId-6260957]Apply NAT Rules
  
         	[bookmark: pgfId-6260959]yes
  
         	[bookmark: pgfId-6260961]no
  
        
 
         
         	[bookmark: pgfId-6260963]VPN
  
         	[bookmark: pgfId-6260965]yes
  
         	[bookmark: pgfId-6260967]yes
  
        
 
         
         	[bookmark: pgfId-6260969]Modify VPN
  
         	[bookmark: pgfId-6260971]yes
  
         	[bookmark: pgfId-6260973]yes
  
        
 
         
         	[bookmark: pgfId-6260975]Apply VPN Changes
  
         	[bookmark: pgfId-6260977]yes
  
         	[bookmark: pgfId-6260979]yes
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-6260698][bookmark: 74968]Object Manager
 
     [bookmark: pgfId-5929492]License: Any
 
     [bookmark: pgfId-5929520]The Object Manager permission is available to the Access Admin, Administrator, and Network Admin user roles. The Object Manager permission is only available on the Defense Center.
 
    
 
     
      [bookmark: pgfId-5978469][bookmark: 71480]FireAMP
 
     [bookmark: pgfId-5978470]License: Any
 
     [bookmark: pgfId-5978471]The FireAMP permission is available only to the Administrator user role. This permission is only available on the Defense Center.
 
    
 
     
      [bookmark: pgfId-5911186][bookmark: 56502]Health Menu 
 
     [bookmark: pgfId-5911187]License: Any
 
      
       
        
        [bookmark: pgfId-5959823]Table 61-10 [bookmark: 78773]Health Menu 
 
        
        
         
         	 
           
           [bookmark: pgfId-5959833]Menu 
          
  
         	 
           
           [bookmark: pgfId-5959835]Admin 
          
  
         	 
           
           [bookmark: pgfId-5959837]Maint User 
          
  
         	 
           
           [bookmark: pgfId-5959839]Security Analyst 
          
  
         	 
           
           [bookmark: pgfId-5959841]Security Analyst (RO) 
          
  
        
 
         
         	[bookmark: pgfId-5959843]Health Policy
  
         	[bookmark: pgfId-5959845]yes
  
         	[bookmark: pgfId-5959847]yes
  
         	[bookmark: pgfId-5959849]no
  
         	[bookmark: pgfId-5959851]no
  
        
 
         
         	[bookmark: pgfId-5959853]Modify Health Policy
  
         	[bookmark: pgfId-5959855]yes
  
         	[bookmark: pgfId-5959857]yes
  
         	[bookmark: pgfId-6096599]no
  
         	[bookmark: pgfId-6096601]no
  
        
 
         
         	[bookmark: pgfId-5959863]Apply Health Policy
  
         	[bookmark: pgfId-5959865]yes
  
         	[bookmark: pgfId-5959867]yes
  
         	[bookmark: pgfId-6096607]no
  
         	[bookmark: pgfId-6096609]no
  
        
 
         
         	[bookmark: pgfId-5959873]Health Events
  
         	[bookmark: pgfId-5959875]yes
  
         	[bookmark: pgfId-5959877]yes
  
         	[bookmark: pgfId-5959879]yes
  
         	[bookmark: pgfId-5959881]yes
  
        
 
         
         	[bookmark: pgfId-5959883]Modify Health Events
  
         	[bookmark: pgfId-5959885]yes
  
         	[bookmark: pgfId-5959887]yes
  
         	[bookmark: pgfId-6096615]no
  
         	[bookmark: pgfId-6096617]no
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-5959894][bookmark: 89414]System Menu 
 
     [bookmark: pgfId-5913123]License: Any
 
     [bookmark: pgfId-5913224]The following table lists, in order, the user role privileges required to access each option in the System menu and whether the user role has access to the sub-permissions within. The Access Admin, Discovery Admin, Intrusion Admin, External Database User, and Security Analyst (Read Only) roles have no permissions in the System Menu.
 
     [bookmark: pgfId-5913225]
 
      
       
        
        [bookmark: pgfId-5933034]Table 61-11 [bookmark: 62754]System Menu 
 
        
        
         
         	 
           
           [bookmark: pgfId-5933046]Menu 
          
  
         	 
           
           [bookmark: pgfId-5933048]Admin 
          
  
         	 
           
           [bookmark: pgfId-5933050]Maint User 
          
  
         	 
           
           [bookmark: pgfId-5933052]Network Admin 
          
  
         	 
           
           [bookmark: pgfId-5933054]Security Approver 
          
  
         	 
           
           [bookmark: pgfId-5933056]Security Analyst 
          
  
        
 
         
         	[bookmark: pgfId-5933058]Local
  
         	[bookmark: pgfId-6095979]yes
  
         	[bookmark: pgfId-5933062]no
  
         	[bookmark: pgfId-5933064]no
  
         	[bookmark: pgfId-5933066]no
  
         	[bookmark: pgfId-5933068]no
  
        
 
         
         	[bookmark: pgfId-5933070]Configuration
  
         	[bookmark: pgfId-6095981]yes
  
         	[bookmark: pgfId-6096245]no
  
         	[bookmark: pgfId-6096247]no
  
         	[bookmark: pgfId-6096249]no
  
         	[bookmark: pgfId-6096251]no
  
        
 
         
         	[bookmark: pgfId-5933082]Registration
  
         	[bookmark: pgfId-6095983]yes
  
         	[bookmark: pgfId-6096257]no
  
         	[bookmark: pgfId-6096259]no
  
         	[bookmark: pgfId-6096261]no
  
         	[bookmark: pgfId-6096263]no
  
        
 
         
         	[bookmark: pgfId-5933094]High Availability (DC1000, DC1500, DC2000, DC3000, DC3500, DC4000 only)
  
         	[bookmark: pgfId-6095985]yes
  
         	[bookmark: pgfId-6096265]no
  
         	[bookmark: pgfId-6096267]no
  
         	[bookmark: pgfId-6096269]no
  
         	[bookmark: pgfId-6096271]no
  
        
 
         
         	[bookmark: pgfId-5933106]eStreamer
  
         	[bookmark: pgfId-6095987]yes
  
         	[bookmark: pgfId-6096277]no
  
         	[bookmark: pgfId-6096279]no
  
         	[bookmark: pgfId-6096281]no
  
         	[bookmark: pgfId-6096283]no
  
        
 
         
         	[bookmark: pgfId-5933118]Host Input Client (Defense Center only)
  
         	[bookmark: pgfId-6095993]yes
  
         	[bookmark: pgfId-6096285]no
  
         	[bookmark: pgfId-6096287]no
  
         	[bookmark: pgfId-6096289]no
  
         	[bookmark: pgfId-6096291]no
  
        
 
         
         	[bookmark: pgfId-5933130]User Management
  
         	[bookmark: pgfId-6095995]yes
  
         	[bookmark: pgfId-6096293]no
  
         	[bookmark: pgfId-6096295]no
  
         	[bookmark: pgfId-6096297]no
  
         	[bookmark: pgfId-6096299]no
  
        
 
         
         	[bookmark: pgfId-6086276]Users
  
         	[bookmark: pgfId-6095997]yes
  
         	[bookmark: pgfId-6096301]no
  
         	[bookmark: pgfId-6096303]no
  
         	[bookmark: pgfId-6096305]no
  
         	[bookmark: pgfId-6096307]no
  
        
 
         
         	[bookmark: pgfId-6086288]User Roles
  
         	[bookmark: pgfId-6095999]yes
  
         	[bookmark: pgfId-6096313]no
  
         	[bookmark: pgfId-6096315]no
  
         	[bookmark: pgfId-6096317]no
  
         	[bookmark: pgfId-6096319]no
  
        
 
         
         	[bookmark: pgfId-5934012]Login Authentication (Defense Center only)
  
         	[bookmark: pgfId-6096001]yes
  
         	[bookmark: pgfId-6096321]no
  
         	[bookmark: pgfId-6096323]no
  
         	[bookmark: pgfId-6096325]no
  
         	[bookmark: pgfId-6096327]no
  
        
 
         
         	[bookmark: pgfId-5933142]System Policy (Defense Center only)
  
         	[bookmark: pgfId-6096007]yes
  
         	[bookmark: pgfId-6096329]no
  
         	[bookmark: pgfId-6096331]no
  
         	[bookmark: pgfId-6096333]no
  
         	[bookmark: pgfId-6096335]no
  
        
 
         
         	[bookmark: pgfId-6582212]Apply System Policy (Defense Center only)
  
         	[bookmark: pgfId-6582214]yes
  
         	[bookmark: pgfId-6582216]no
  
         	[bookmark: pgfId-6582218]no
  
         	[bookmark: pgfId-6582220]no
  
         	[bookmark: pgfId-6582222]no
  
        
 
         
         	[bookmark: pgfId-5933154]Modify System Policy (Defense Center only)
  
         	[bookmark: pgfId-6096009]yes
  
         	[bookmark: pgfId-6096337]no
  
         	[bookmark: pgfId-6096339]no
  
         	[bookmark: pgfId-6096341]no
  
         	[bookmark: pgfId-6096343]no
  
        
 
         
         	[bookmark: pgfId-5933178]Updates
  
         	[bookmark: pgfId-6096013]yes
  
         	[bookmark: pgfId-6096357]no
  
         	[bookmark: pgfId-6096359]no
  
         	[bookmark: pgfId-6096361]no
  
         	[bookmark: pgfId-6096363]no
  
        
 
         
         	[bookmark: pgfId-5933190]Rule Updates (Defense Center only)
  
         	[bookmark: pgfId-6096015]yes
  
         	[bookmark: pgfId-6096365]no
  
         	[bookmark: pgfId-6096367]no
  
         	[bookmark: pgfId-6096369]no
  
         	[bookmark: pgfId-6096371]no
  
        
 
         
         	[bookmark: pgfId-5933202]Rule Update Import Log (Defense Center only)
  
         	[bookmark: pgfId-6096021]yes
  
         	[bookmark: pgfId-6096373]no
  
         	[bookmark: pgfId-6096375]no
  
         	[bookmark: pgfId-6096377]no
  
         	[bookmark: pgfId-6096379]no
  
        
 
         
         	[bookmark: pgfId-5997199]Licenses
  
         	[bookmark: pgfId-6096023]yes
  
         	[bookmark: pgfId-6096385]no
  
         	[bookmark: pgfId-6096387]no
  
         	[bookmark: pgfId-6096389]no
  
         	[bookmark: pgfId-6096391]no
  
        
 
         
         	[bookmark: pgfId-5933214]Monitoring
  
         	[bookmark: pgfId-6096025]yes
  
         	[bookmark: pgfId-5933218]yes
  
         	[bookmark: pgfId-6096117]yes
  
         	[bookmark: pgfId-6096119]yes
  
         	[bookmark: pgfId-6096125]yes
  
        
 
         
         	[bookmark: pgfId-5933226]Audit
  
         	[bookmark: pgfId-6096027]yes
  
         	[bookmark: pgfId-6096397]no
  
         	[bookmark: pgfId-6096399]no
  
         	[bookmark: pgfId-6096401]no
  
         	[bookmark: pgfId-6096403]no
  
        
 
         
         	[bookmark: pgfId-5933238]Modify Audit Log
  
         	[bookmark: pgfId-6096029]yes
  
         	[bookmark: pgfId-6096413]no
  
         	[bookmark: pgfId-6096415]no
  
         	[bookmark: pgfId-6096417]no
  
         	[bookmark: pgfId-6096419]no
  
        
 
         
         	[bookmark: pgfId-5933250]Syslog
  
         	[bookmark: pgfId-6096039]yes
  
         	[bookmark: pgfId-5933254]yes
  
         	[bookmark: pgfId-6096461]no
  
         	[bookmark: pgfId-6096463]no
  
         	[bookmark: pgfId-6096465]no
  
        
 
         
         	[bookmark: pgfId-5933262]Task Status
  
         	[bookmark: pgfId-6096041]yes
  
         	[bookmark: pgfId-6096131]yes
  
         	[bookmark: pgfId-6096133]yes
  
         	[bookmark: pgfId-6096135]yes
  
         	[bookmark: pgfId-6096137]yes
  
        
 
         
         	[bookmark: pgfId-5933274]View Other Users’ Tasks
  
         	[bookmark: pgfId-6096043]yes
  
         	[bookmark: pgfId-6096475]no
  
         	[bookmark: pgfId-6096477]no
  
         	[bookmark: pgfId-6096479]no
  
         	[bookmark: pgfId-6096481]no
  
        
 
         
         	[bookmark: pgfId-5933286]Statistics
  
         	[bookmark: pgfId-6096045]yes
  
         	[bookmark: pgfId-6096087]yes
  
         	[bookmark: pgfId-6096491]no
  
         	[bookmark: pgfId-6096493]no
  
         	[bookmark: pgfId-6096495]no
  
        
 
         
         	[bookmark: pgfId-5933298]Tools
  
         	[bookmark: pgfId-6096047]yes
  
         	[bookmark: pgfId-6096089]yes
  
         	[bookmark: pgfId-6096561]no
  
         	[bookmark: pgfId-6096563]no
  
         	[bookmark: pgfId-5933308]yes
  
        
 
         
         	[bookmark: pgfId-5933310]Backup Management
  
         	[bookmark: pgfId-6096057]yes
  
         	[bookmark: pgfId-6096091]yes
  
         	[bookmark: pgfId-6096505]no
  
         	[bookmark: pgfId-6096507]no
  
         	[bookmark: pgfId-6096509]no
  
        
 
         
         	[bookmark: pgfId-5933322]Restore Backup
  
         	[bookmark: pgfId-6096059]yes
  
         	[bookmark: pgfId-6096093]yes
  
         	[bookmark: pgfId-6096519]no
  
         	[bookmark: pgfId-6096521]no
  
         	[bookmark: pgfId-6096523]no
  
        
 
         
         	[bookmark: pgfId-5933334]Scheduling
  
         	[bookmark: pgfId-6096061]yes
  
         	[bookmark: pgfId-6096095]yes
  
         	[bookmark: pgfId-6096533]no
  
         	[bookmark: pgfId-6096535]no
  
         	[bookmark: pgfId-6096537]no
  
        
 
         
         	[bookmark: pgfId-5933346]Delete Other Users’ Scheduled Tasks
  
         	[bookmark: pgfId-6096063]yes
  
         	[bookmark: pgfId-6096429]no
  
         	[bookmark: pgfId-6096431]no
  
         	[bookmark: pgfId-6096433]no
  
         	[bookmark: pgfId-6096435]no
  
        
 
         
         	[bookmark: pgfId-5933358]Import/Export
  
         	[bookmark: pgfId-6096065]yes
  
         	[bookmark: pgfId-6096445]no
  
         	[bookmark: pgfId-6096447]no
  
         	[bookmark: pgfId-6096449]no
  
         	[bookmark: pgfId-6096451]no
  
        
 
         
         	[bookmark: pgfId-5933370]Discovery Data Purge (Defense Center only)
  
         	[bookmark: pgfId-6096075]yes
  
         	[bookmark: pgfId-6096547]no
  
         	[bookmark: pgfId-6096549]no
  
         	[bookmark: pgfId-6096551]no
  
         	[bookmark: pgfId-5933380]yes
  
        
 
         
         	[bookmark: pgfId-5997149]Whois
  
         	[bookmark: pgfId-6096077]yes
  
         	[bookmark: pgfId-5997153]yes
  
         	[bookmark: pgfId-6096573]no
  
         	[bookmark: pgfId-6096575]no
  
         	[bookmark: pgfId-5997159]yes
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-5915024][bookmark: 15529]Help Menu
 
     [bookmark: pgfId-5915041]License: Any
 
     [bookmark: pgfId-5915048]The Help menu and its permissions are accessible to all user roles. You cannot restrict Help menu options.
 
    
 
   
 
    
     [bookmark: pgfId-5913227][bookmark: 96456]Managing User R[bookmark: marker-5953951]ole Escalation
 
    [bookmark: pgfId-6025281]License: Any
 
    [bookmark: pgfId-5890088]You can give custom user roles the permission, with a password, to temporarily gain the privileges of another, targeted user role in addition to those of the base role. This allows you to easily substitute one user for another during an absence, or to more closely track the use of advanced user privileges.
 
    [bookmark: pgfId-5890089]For example, a user whose base role has very limited privileges may escalate to the Administrator role to perform administrative actions. You can configure this feature so that users can use their own passwords, or so they use the password of another user that you specify. The second option allows you to easily manage one escalation password for all applicable users. For more information, see Configuring a Custom User Role for Escalation.
 
    [bookmark: pgfId-5890093]Note that only one user role at a time can be the escalation target role. You can use a custom or predefined user role. Each escalation lasts for the duration of a login session and is recorded in the audit log.
 
    [bookmark: pgfId-5890094]For more information on configuring and using this feature, please see the following sections:
 
     
     	 [bookmark: pgfId-5890098]Configuring the Escalation Target Role
 
     	 [bookmark: pgfId-5890102]Configuring a Custom User Role for Escalation
 
     	 [bookmark: pgfId-5890106]Escalating Your User Role
 
    
 
     
      [bookmark: pgfId-5890108][bookmark: 90579]Configuring the Escala[bookmark: marker-5953961]tion Target Role
 
     [bookmark: pgfId-5915498]License: Any
 
     [bookmark: pgfId-5890109]You can assign any of your user roles, predefined or custom, to act as the system-wide escalation target role. This is the role to which any other role may escalate, if it has the ability.
 
     [bookmark: pgfId-5890110]To configure the escalation target role:
 
     [bookmark: pgfId-5890111]Access: Admin
 
     
 
     [bookmark: pgfId-5900214]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-5890113]The User Management page appears.
 
     [bookmark: pgfId-5890114]Step 2 Click User Roles.
 
     [bookmark: pgfId-5890115]The User Roles page appears.
 
     [bookmark: pgfId-5890116]Step 3 Click Configure Permission Escalation.
 
     [bookmark: pgfId-5890117]The Configure Permission Escalation dialog box appears.
 
     [bookmark: pgfId-5890122]Step 4 Select a user role from the drop-down list.
 
     [bookmark: pgfId-5890123]Step 5 Click OK to save your changes.
 
     [bookmark: pgfId-5890124]Your changes are saved and the User Roles page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-5890125]Note Changing the escalation target role is effective immediately. Users in escalated sessions now have the permissions of the new escalation target.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-6285340]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5890127][bookmark: 87269]Configuring a Custom Us[bookmark: marker-5953968]er Role for Escalation
 
     [bookmark: pgfId-5915509]License: Any
 
     [bookmark: pgfId-5890128]To use the user role escalation feature, you must first configure a custom user role with the escalation permission, select its escalation password, and assign that role to a user. For more information, see Adding New User Accounts and Configuring User Roles.
 
     [bookmark: pgfId-5890135]Consider the needs of your organization when you configure the escalation password for a custom role. If you want to easily manage many escalating users, you may want to select another user whose password serves as the escalation password. If you change that user’s password or deactivate that user, all escalating users who require that password are affected. This allows you to manage user role escalation more efficiently, especially if you select an externally authenticated user that you can manage centrally.
 
     [bookmark: pgfId-5890136]To configure a custom user role for escalation:
 
     [bookmark: pgfId-5890137]Access: Admin
 
     
 
     [bookmark: pgfId-5900227]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-5890139]The User Management page appears.
 
     [bookmark: pgfId-5890140]Step 2 Click User Roles.
 
     [bookmark: pgfId-5890141]The User Roles page appears.
 ) next to an existing custom user role. 
     
 
     [bookmark: pgfId-5890143]The User Role Editor page appears.
 
     [bookmark: pgfId-5890144]Step 4 Choose a name, description and menu-based permissions for the custom user role. 
 
     [bookmark: pgfId-5890148]For more information, see the procedure in Managing Custom User Roles.
 
     [bookmark: pgfId-5890149]Step 5 In System Permissions, select the Set this role to escalate to: check box.
 
     [bookmark: pgfId-5890150]The escalation password options appear.
 
     [bookmark: pgfId-5890155]Step 6 Select the password that this role uses to escalate. You have two options:
 
      
       
       	 [bookmark: pgfId-5890156]If you want users with this role to use their own passwords when they escalate, select  Authenticate with the assigned user’s password .
 
       	 [bookmark: pgfId-5890157]If you want users with this role to use the password of another user, select  Authenticate with the specified user’s password and type that username.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-5890158]Note When authenticating with another user’s password, you can enter any username, even that of a deactivated or nonexistent user. Deactivating the user whose password is used for escalation makes escalation impossible for users with the role that requires it. You can use this feature to quickly remove escalation powers if necessary.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5890159]Step 7 Click Save.
 
     [bookmark: pgfId-5890160]Your changes are saved and the User Roles page appears again. Users with this role can now escalate to the target user role. For more information on assigning roles to a user, see Adding New User Accounts.
 
     [bookmark: pgfId-6286683]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5890165][bookmark: 38563]Escalating Your User Role
 
     [bookmark: pgfId-5915523]License: Any
 
     [bookmark: pgfId-5890166]When a user has an assigned custom user role with permission to escalate, that user may escalate to the target role’s permissions at any time. Note that escalation has no effect on user preferences. The Escalate Permissions option in the User menu does not appear if your assigned user role is not configured for user role escalation.
 
     [bookmark: pgfId-5890167]To escalate user permissions:
 
     [bookmark: pgfId-5890168]Access: Any
 
     
 
     [bookmark: pgfId-5890169]Step 1 Select Local > User > Escalate Permissions.
 
     [bookmark: pgfId-5890170]The Escalate User Permissions dialog box appears.
 
     [bookmark: pgfId-5890175]Step 2 Enter the authentication password.
 
     [bookmark: pgfId-5890176]Step 3 Click Escalate. 
 
     [bookmark: pgfId-5890177]You now have all permissions of the escalation target role in addition to your current role.
 
     [bookmark: pgfId-6215304]Note that escalation lasts for the remainder of your login session. To return to the privileges of your base role only, you must log out, then begin a new session.
 
     [bookmark: pgfId-6285387]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-6215307][bookmark: 70856]Configuring Single Sign-on from Cisco Security Manager
 
    [bookmark: pgfId-6215315]License: Any
 
    [bookmark: pgfId-6118209]Supported Devices: ASA FirePOWER
 
    [bookmark: pgfId-6111801]Single sign-on (SSO) enables integration between Cisco Security Manager (CSM) Version 4.7 or higher and the Defense Center, which allows you to access the Defense Center from CSM without additional authentication to log in. When managing the ASA module of an ASA FirePOWER device, you may want to modify the policies applied to the FirePOWER module of the device. You can select the managing Defense Center in CSM and launch it in a web browser. If the managing Defense Center is a member of a high availability pair, using SSO navigates you to the primary peer.
 
    [bookmark: pgfId-6217574]If you have access based on your user role, the system navigates you to the Device tab of the Device Management page for the device you cross-launched from in CSM. Otherwise, the system navigates you to the Summary Dashboard page (Overview > Dashboards), except for user accounts with no dashboard access, which use the Welcome page.
 
    [bookmark: pgfId-6111905]Before you can SSO to a Defense Center, you must set up a one-way, encrypted authentication path from CSM to the Defense Center. In NAT environments, the Defense Center and CSM must reside on the same side of the NAT boundary. To enable communications, you must provide the following criteria for CSM and the Defense Center to recognize each other:
 
     
     	 [bookmark: pgfId-6118025]From CSM, you must generate an SSO shared encryption key that identifies the connection. You must enter this key on the Defense Center.
 
     	 [bookmark: pgfId-6118034]On the Defense Center, you provide the CSM server hostname or IP address, along with the server port. If you are using high availability, configure SSO on the primary peer.
 
     	 [bookmark: pgfId-6117874]To validate the encrypted authentication parameters, you must set up the same usernames (case insensitive) on CSM and the Defense Center for all users who should have SSO access.
 
    
 
    [bookmark: pgfId-6289241]The system disables SSO when STIG compliance is enabled for the Defense Center. See Enabling STIG Compliance for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-6371195]Note You cannot login with single sign-on if your organization uses CACs for authentication. For more information, see Understanding LDAP Authentication With CAC.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-6217422]To set up single sign-on:
 
    [bookmark: pgfId-6111937]Access: Admin
 
    
 
    [bookmark: pgfId-6112095]Step 1 From CSM, generate an SSO shared encryption key.
 
    [bookmark: pgfId-6113677]See your CSM documentation for more information.
 
    [bookmark: pgfId-6112098]Step 2 From the Defense Center, select System > Local > User Management.
 
    [bookmark: pgfId-6112131]The User Management page appears.
 
    [bookmark: pgfId-6112166]Step 3 Select CSM Single Sign-on.
 
    [bookmark: pgfId-6112190]The CSM Single Sign-on page appears.
 
    [bookmark: pgfId-6112229]Step 4 Enter the CSM hostname or IP address and the server Port.
 
    [bookmark: pgfId-6112370]Step 5 Enter the Shared key that you generated from CSM.
 
    [bookmark: pgfId-6611419]Step 6 Optionally, if you want to use the Defense Center’s proxy server to communicate with CSM, select the Use Proxy For Connection check box. For more information, see Understanding Management Interface Options.
 
    [bookmark: pgfId-6112396]Step 7 Click Submit.
 
    [bookmark: pgfId-6112411]The CSM certificate appears.
 
    [bookmark: pgfId-6112499]Step 8 Click Confirm Certificate to save the Certificate.
 
    [bookmark: pgfId-6112531]You can now log in from CSM to the Defense Center without an additional login.
 
    [bookmark: pgfId-6285403]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5606216]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-5499866][bookmark: 24880]Scheduling[bookmark: marker-5499865] Tasks 
      
      
 
     
 
 
    [bookmark: pgfId-5499867]You can schedule many different types of administrative tasks to run at designated times, either once or on a recurring basis.
 
     
      
    
 
    
 
    [bookmark: pgfId-1898625]Note Some tasks (such as those involving automated software updates or that require pushing updates to managed devices) may place a significant load on networks with low bandwidths. You should schedule tasks like these to run during periods of low network use.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1911928]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1915450]Configuring a Recurring Task explains how to set up a scheduled task so that it runs at regular intervals.
 
     	 [bookmark: pgfId-4652624]Automating Backup Jobs provides procedures for scheduling backup jobs.
 
     	 [bookmark: pgfId-5375854]Automating Certificate Revocation List Downloads provides procedures for automatically refreshing the certificate revocation list (CRL) for an appliance.
 
     	 [bookmark: pgfId-5403039]Automating Nmap Scans provides procedures for scheduling Nmap scans.
 
     	 [bookmark: pgfId-5403043]Automating Applying an Intrusion Policy provides procedures for queuing an intrusion policy apply on managed devices.
 
     	 [bookmark: pgfId-5375871]Automating Report Generation provides procedures for scheduling reports.
 
     	 [bookmark: pgfId-5437747]Automating Geolocation Database Updates provides procedures for scheduling automatic updates of the geolocation database (GeoDB).
 
     	 [bookmark: pgfId-5437735]Automating FireSIGHT Recommendations provides procedures for scheduling the automatic update of intrusion rule state recommendations.
 
     	 [bookmark: pgfId-5437740]Automating Software Updates provides procedures for scheduling the download, push, and installation of software updates.
 
     	 [bookmark: pgfId-5384750]Automating Vulnerability Database Updates provides procedures for scheduling the download and installation of VDB updates.
 
     	 [bookmark: pgfId-5384756]Automating URL Filtering Updates provides procedures for automating updates of URL filtering data.
 
     	 [bookmark: pgfId-5384760]Viewing Tasks describes how to view and manage tasks after they are scheduled.
 
     	 [bookmark: pgfId-4925446]Editing Scheduled Tasks describes how to edit an existing task.
 
     	 [bookmark: pgfId-1918501]Deleting Scheduled Tasks describes how to delete one-time tasks and all instances of recurring tasks.
 
    
 
   
 
    
     [bookmark: pgfId-4635130][bookmark: 16104]Configuring a[bookmark: marker-4846378] Recurring Task
 
    [bookmark: pgfId-5367951]License: Any
 
    [bookmark: pgfId-4635135]You set the frequency for a recurring task using the same process for all types of tasks.
 
    [bookmark: pgfId-4790807]Note that the time displayed on most pages on the web interface is the local time, which is determined by using the time zone you specify in your local configuration. Further, the Defense Center automatically adjusts its local time display for daylight saving time (DST), where appropriate. However, recurring tasks that span the transition dates from DST to standard time and back do not adjust for the transition. That is, if you create a task scheduled for 2:00 AM during standard time, it will run at 3:00 AM during DST. Similarly, if you create a task scheduled for 2:00 AM during DST, it will run at 1:00 AM during standard time.
 
    [bookmark: pgfId-4635252]To configure a recurring task:
 
    [bookmark: pgfId-5004330]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5367986]Step 1 Select System > Tools > Scheduling.
 
    [bookmark: pgfId-4635322]The Scheduling page appears.
 
    [bookmark: pgfId-4635368]Step 2 Click Add Task.
 
    [bookmark: pgfId-4635369]The New Task page appears.
 
    [bookmark: pgfId-4635393]Step 3 From the Job Type list, select the type of task that you want to schedule.
 
    [bookmark: pgfId-4635421]Each of the types of tasks you can schedule is explained in its own section.
 
    [bookmark: pgfId-4635442]Step 4 For the Schedule task to run option, select Recurring.
 
    [bookmark: pgfId-4635492]The page reloads with the recurring task options.
 
    [bookmark: pgfId-4635513]Step 5 In the Start On field, specify the date when you want to start your recurring task. You can use the drop-down list to select the month, day, and year.
 
    [bookmark: pgfId-4635682]Step 6 In the Repeat Every field, specify how often you want the task to recur. You can specify a number of hours, days, weeks, or months. 
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-4635910]Step 7 In the Run At field, specify the time when you want to start your recurring task.
 
   [bookmark: pgfId-4635950]Step 8 If you selected Weeks for Repeat Every, a Repeat On field appears. Select the check boxes next to the days of the week when you want to run the task.
 
   [bookmark: pgfId-5399374]Step 9 If you selected Months for Repeat Every, a Repeat On field appears. Use the drop-down list to select the day of the month when you want to run the task.
 
   [bookmark: pgfId-5399375]The remaining options on the New Task page are determined by the task you are creating. See the following sections for more information:
 
   [bookmark: pgfId-5046715] – Automating Backup Jobs
 
   [bookmark: pgfId-5384042] – Automating Certificate Revocation List Downloads
 
   [bookmark: pgfId-5384052] – Automating Nmap Scans
 
   [bookmark: pgfId-5384095] – Automating Report Generation
 
   [bookmark: pgfId-5384109] – Automating FireSIGHT Recommendations
 
   [bookmark: pgfId-5046719] – Automating Software Updates
 
   [bookmark: pgfId-5368002] – Automating Vulnerability Database Updates
 
   [bookmark: pgfId-5384123] – Automating URL Filtering Updates
 
   [bookmark: pgfId-5472188]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-1901557][bookmark: 48889]Automating Backup[bookmark: marker-4846379] Jobs
 
    [bookmark: pgfId-5368037]License: Any
 
    [bookmark: pgfId-5493447]Supported Devices: Series 2 and Series 3
 
    [bookmark: pgfId-5495259]Supported Defense Centers: Any
 
    [bookmark: pgfId-5495299]You can use the scheduler to automate backups of your Defense Centers or physical managed devices. You must design a backup profile before you can configure a backup as a scheduled task. For more information, see Creating Backup Profiles.
 
    [bookmark: pgfId-5495305]You cannot perform scheduled backups of virtual managed devices, Cisco NGIPS for Blue Coat X-Series, or Cisco ASA with FirePOWER Services. To perform a scheduled backup of the configuration data on a physical managed device, schedule the task from the web interface of the device itself. To perform a scheduled backup of event data, perform a scheduled backup of the managing Defense Center.
 
    [bookmark: pgfId-5495164]To automate backup tasks:
 
    [bookmark: pgfId-5298211]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5368066]Step 1 Select System > Tools > Scheduling. 
 
    [bookmark: pgfId-1913677]The Scheduling page appears.
 
    [bookmark: pgfId-2105567]Step 2 Click Add Task.
 
    [bookmark: pgfId-2105568]The New Task page appears.
 
    [bookmark: pgfId-4652182]Step 3 From the Job Type list, select Backup.
 
    [bookmark: pgfId-4652710]The page reloads to show the backup options.
 
    [bookmark: pgfId-4651741]Step 4 [bookmark: 40879]Specify how you want to schedule the backup, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-4652123]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
      	 [bookmark: pgfId-4652127]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5487034]Step 5 [bookmark: 34749]In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
    [bookmark: pgfId-5487035]Step 6 From the Backup Profile list, select the appropriate backup profile.
 
    [bookmark: pgfId-5487039]For more information on creating new backup profiles, see Creating Backup Profiles.
 
    [bookmark: pgfId-1914413]Step 7 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-1914417]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5486830]Step 8 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5487361]You must have a valid email relay server configured on the Defense Center to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5487365]Step 9 Click Save.
 
    [bookmark: pgfId-5379725]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472194]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5375685][bookmark: 25711]Automating Certificate Rev[bookmark: marker-5407155]ocation List Downloads
 
    [bookmark: pgfId-5376124]License: Any
 
    [bookmark: pgfId-5386471]You can use the scheduler to automatically refresh the certificate revocation list (CRL) for the appliance web server on an appliance where you enable user certificates for the appliance. The Download CRL task is automatically created when you enable fetching of a CRL in the local appliance configuration, so this procedure explains how to open the scheduled task to set the frequency. 
 
     
      
    
 
    
 
    [bookmark: pgfId-5386472]Tip You must enable and configure user certificates and set a CRL download URL before scheduling this task. For information on configuring user certificates, see Requiring User Certificates.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5386476]To automate download of certificate revocation lists:
 
    [bookmark: pgfId-5386477]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5386478]Step 1 Select System > Tools > Scheduling. 
 
    [bookmark: pgfId-5386479]The Scheduling page appears.
 ). 
    
 
    [bookmark: pgfId-5386481]The Edit Task page appears, showing the download options.
 
    [bookmark: pgfId-5386489]Step 3 Specify how you want to schedule the CRL download, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-5386490]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
      	 [bookmark: pgfId-5401964]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5401969]Step 4 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-5386503]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5386504]Step 5 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5386505]You must have a valid email relay server configured on the Defense Center to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5386509]Step 6 Click Save.
 
    [bookmark: pgfId-5386510]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472267]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5376092][bookmark: 13850]Automating Nmap[bookmark: marker-5375684] Scans
 
    [bookmark: pgfId-5376175]License: FireSIGHT
 
    [bookmark: pgfId-5375686]You can schedule regular Nmap scans of targets on your network. Automated scans allow you to refresh information previously supplied by an Nmap scan. Because the FireSIGHT System cannot update Nmap-supplied data, you need to rescan periodically to keep that data up to date. You can also schedule scans to automatically test for unidentified applications or servers on hosts in your network. See the following sections for more information:
 
     
     	 [bookmark: pgfId-5375693]Preparing Your System for an Nmap Scan
 
     	 [bookmark: pgfId-5375697]Scheduling an Nmap Scan
 
    
 
    [bookmark: pgfId-5405592]Note that a Discovery Administrator can also use an Nmap scan as a remediation. For example, when an operating system conflict occurs on a host, that conflict may trigger an Nmap scan. Running the scan obtains updated operating system information for the host, which resolves the conflict. For more information, see Nmap Scan Remediations.
 
     
      [bookmark: pgfId-5405597][bookmark: 37217]Preparing Your System for an Nmap Scan
 
     [bookmark: pgfId-5413549]License: FireSIGHT
 
     [bookmark: pgfId-5375705]If you have not used the Nmap scanning capability before, you must complete several Nmap configuration steps before defining a scheduled scan. See the following sections for more information:
 
      
      	 [bookmark: pgfId-5405053]Creating an Nmap Scan Instance provides information on setting up an Nmap server connection profile.
 
      	 [bookmark: pgfId-5405162]Creating an Nmap Scan Target provides information on setting up a scan target.
 
      	 [bookmark: pgfId-5405615]Creating an Nmap Remediation provides information on setting up a remediation definition.
 
     
 
    
 
     
      [bookmark: pgfId-5405617][bookmark: 95359]Scheduling an Nmap Scan
 
     [bookmark: pgfId-5375731]License: FireSIGHT
 
     [bookmark: pgfId-5404962]You can schedule a scan of a host or hosts on your network using the Nmap utility. 
 
     [bookmark: pgfId-5404963]After Nmap replaces a host’s operating system, applications, or servers detected by the system with the results from an Nmap scan, the system no longer updates the information replaced by Nmap for the host. Nmap-supplied service and operating system data remains static until you run another Nmap scan. If you plan to scan a host using Nmap, you may want to set up regularly scheduled scans to keep Nmap-supplied operating systems, applications, or servers up to date. If the host is deleted from the network map and re-added, any Nmap scan results are discarded and the system resumes monitoring of all operating system and service data for the host.
 
     [bookmark: pgfId-5375743]To automate Nmap scanning:
 
     [bookmark: pgfId-5375744]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5375745]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-5375746]The Scheduling page appears.
 
     [bookmark: pgfId-5375747]Step 2 Click Add Task.
 
     [bookmark: pgfId-5375748]The New Task page appears.
 
     [bookmark: pgfId-5375749]Step 3 From the Job Type list, select Nmap Scan.
 
     [bookmark: pgfId-5375750]The page reloads to show the options for automating Nmap scans.
 
     [bookmark: pgfId-5412331]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
      
       
       	 [bookmark: pgfId-5412332]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
       	 [bookmark: pgfId-5375757]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
      
 
     
 
     [bookmark: pgfId-5375761]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
     [bookmark: pgfId-5375762]Step 6 In the Nmap Remediation field, select the Nmap remediation to use when running the scan.
 
     [bookmark: pgfId-5375763]Step 7 In the Nmap Target field, select the scan target that defines the target hosts you want to scan.
 
     [bookmark: pgfId-5375764]Step 8 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-5375765]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5375766]Step 9 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
     [bookmark: pgfId-5375767]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     [bookmark: pgfId-5375771]Step 10 Click Save.
 
     [bookmark: pgfId-5379745]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
     [bookmark: pgfId-5472294]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-5392436][bookmark: 22283]Automating Applyin[bookmark: marker-5407212]g an Intrusion Policy
 
    [bookmark: pgfId-5392514]License: Protection
 
    [bookmark: pgfId-5392562]You can queue an intrusion policy apply to a managed device. This task only applies the intrusion policy if an access control policy that references the intrusion policy is applied to the selected device when the task runs. Otherwise, the task aborts before completion.
 
    [bookmark: pgfId-5419085]You must associate an intrusion policy with an access control policy and apply the access control policy to a device before scheduling this task; see Controlling Traffic Using Intrusion and File Policies.
 
    [bookmark: pgfId-5419030]To queue a policy apply to a managed device:
 
    [bookmark: pgfId-5393041]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5393070]Step 1 Select System > Tools > Scheduling.
 
    [bookmark: pgfId-5393113]The schedule calendar page for the current month appears.
 
    [bookmark: pgfId-5393180]Step 2 Click Add Task.
 
    [bookmark: pgfId-5393216]The New Task page appears.
 
    [bookmark: pgfId-5393552]Step 3 From the Job Type list, select Queue Intrusion Policy Apply.
 
    [bookmark: pgfId-5393543]The page reloads to show the options for queuing a policy apply. 
 
    [bookmark: pgfId-5393666]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-5393667]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the Defense Center.
 
      	 [bookmark: pgfId-5393671]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5393675]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
    [bookmark: pgfId-5393596]Step 6 In the Intrusion Policy field, you have the following options:
 
     
      
      	 [bookmark: pgfId-5396809]Select an intrusion policy to apply to the selected target device. 
 
      	 [bookmark: pgfId-5396812]Select  All intrusion policies to apply all intrusion policies already applied to the device selected in the  Device  field.
 
     
 
    
 
    [bookmark: pgfId-5394799]Step 7 In the Device field, you have the following options:
 
     
      
      	 [bookmark: pgfId-5396861]Select a device to which you want to apply the intrusion policy selected in the  Intrusion Policy field. 
 
      	 [bookmark: pgfId-5396868]Select  All targeted devices to apply the selected intrusion policy to all monitored devices which already have that intrusion policy applied.
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-5436961]Tip This field only displays devices which have the intrusion policy selected in the Intrusion Policy field already applied.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5435872]Step 8 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-5393751]Tip The comment field appears in the Tasks Details section at the bottom of the schedule calendar page, so you should limit the size of your comment.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5393752]Step 9 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5393753]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5393757]Step 10 Click Save.
 
    [bookmark: pgfId-5393758]The task is added. You can check the status of a running task in the Task Details section of the calendar page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5393762]Step 11 To edit your saved task, click the task anywhere it appears on the schedule calendar page.
 ). 
    
 
    [bookmark: pgfId-5472351]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5375987][bookmark: 20497]Automating[bookmark: marker-5375986] Report Generation
 
    [bookmark: pgfId-5375988]License: Any
 
    [bookmark: pgfId-5495543]Supported Devices: Any but X-Series
 
    [bookmark: pgfId-5375989]You can automate reports so that they run at regular intervals. However, you must design a template for your report before you can configure it as a scheduled task. See Understanding Report Templates for more information about using the report designer to create a report template.
 
    [bookmark: pgfId-5488864]If you also want to distribute email reports using the scheduler, you must configure your report template and a mail relay host before scheduling the task. For more information, see Distributing Reports by Email at Generation Time and Configuring a Mail Relay Host and Notification Address.
 
    [bookmark: pgfId-5375993]To automate report generation:
 
    [bookmark: pgfId-5375994]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5375995]Step 1 Select System > Tools > Scheduling. 
 
    [bookmark: pgfId-5375996]The schedule calendar page for the current month appears.
 
    [bookmark: pgfId-5375997]Step 2 Click Add Task.
 
    [bookmark: pgfId-5375998]The New Task page appears.
 
    [bookmark: pgfId-5375999]Step 3 From the Job Type list, select Report.
 
    [bookmark: pgfId-5376000]The page reloads to show the options for setting up a report to run automatically.
 
    [bookmark: pgfId-5376008]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-5376009]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the Defense Center.
 
      	 [bookmark: pgfId-5376010]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5487544]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
    [bookmark: pgfId-5487545]Step 6 In the Report Template field, select the report template that you want to use from the drop-down list. For more information, see Creating and Editing Report Templates.
 
    [bookmark: pgfId-5487546]Step 7 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-5385479]Tip The comment field appears in the Tasks Details section at the bottom of the schedule calendar page, so you should limit the size of your comment.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5488770]Step 8 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5488773]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     
      
    
 
    
 
    [bookmark: pgfId-5488751]Note Configuring this option does not distribute the reports. For more information, see Distributing Reports by Email at Generation Time.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5445433]Step 9 If you do not want to receive report email attachments when reports have no data (for example, when no events of a certain type occurred during the report period), select the If report is empty, still attach to email check box.
 
    [bookmark: pgfId-5376028]Step 10 Click Save.
 
    [bookmark: pgfId-5379765]The task is added. You can check the status of a running task in the Task Details section of the calendar page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5385500]Step 11 To edit your saved task, click the task anywhere it appears on the schedule calendar page.
 ). 
    
 
    [bookmark: pgfId-5472370]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5437511][bookmark: 55744]Automating Geolocation Database Updates
 
    [bookmark: pgfId-5465438]License: FireSIGHT
 
    [bookmark: pgfId-5465442]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-5465443]You can use the scheduler to automate recurring geolocation database (GeoDB) updates. Recurring GeoDB updates run once every 7 days (weekly); you can configure the time the update recurs each week. For more information on GeoDB updates, see Updating the Geolocation Database.
 
    [bookmark: pgfId-5438076]To automate geolocation database updates:
 
    [bookmark: pgfId-5438167]Access: Admin
 
    
 
    [bookmark: pgfId-5438180]Step 1 Select System > Updates.
 
    [bookmark: pgfId-5438205]The Product Updates page appears.
 
    [bookmark: pgfId-5438254]Step 2 Click the Geolocation Updates tab.
 
    [bookmark: pgfId-5438302]The Geolocation Updates page appears.
 
    [bookmark: pgfId-5438377]Step 3 Under Recurring Geolocation Updates, select the Enable Recurring Weekly Updates check box.
 
    [bookmark: pgfId-5438767]The Update Start Time field appears.
 
    [bookmark: pgfId-5438808]Step 4 In the Update Start Time field, specify the time and day of the week when you want weekly GeoDB updates to occur.
 
    [bookmark: pgfId-5439056]Step 5 Click Save.
 
    [bookmark: pgfId-5439071]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472390]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5407568][bookmark: 97453]Automating FireSIGHT Recom[bookmark: marker-5407567]mendations
 
    [bookmark: pgfId-5407575]License: Protection
 
    [bookmark: pgfId-5376320]You can automatically generate rule state recommendations based on network discovery data for your network using the most recently saved configuration settings in a custom intrusion policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-5376322]Note If the system automatically generates scheduled recommendations for an intrusion policy with unsaved changes, you must discard your changes in that policy and commit the policy if you want the policy to reflect the automatically generated recommendations. See Resolving Conflicts and Committing Policy Changes for more information.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5376326]When the task runs, the system automatically generates recommended rule states. Optionally, depending on the configuration of your policy, it also modifies the states of intrusion rules based on the criteria described in Tailoring Intrusion Protection to Your Network Assets. Modified rule states take effect the next time you apply your intrusion policy.
 
    [bookmark: pgfId-5376333]To automate rule state recommendation generation:
 
    [bookmark: pgfId-5376334]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5376335]Step 1 Select System > Tools > Scheduling. 
 
    [bookmark: pgfId-5376336]The Scheduling page appears.
 
    [bookmark: pgfId-5376337]Step 2 Click Add Task.
 
    [bookmark: pgfId-5376338]The New Task page appears.
 
    [bookmark: pgfId-5376342]Step 3 From the Job Type list, select FireSIGHT Recommended Rules.
 
    [bookmark: pgfId-5376345]The page reloads to show the options for generating FireSIGHT recommendations.
 
    [bookmark: pgfId-5376351]Step 4 Optionally, click the policies link next to the Job Type field to display the Detection & Prevention page, where you can configure FireSIGHT Recommended Rules in an intrusion policy.
 
    [bookmark: pgfId-5376358]Step 5 Specify how you want to schedule the task, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-5376359]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
      	 [bookmark: pgfId-5376360]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5376364]Step 6 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
    [bookmark: pgfId-5376365]Step 7 Next to Policies, select one or more policies where you want to generate recommendations. You have the following options:
 
     
      
      	 [bookmark: pgfId-5376366]In the  Policies field, select one or more policies. Use the Shift and Ctrl keys to select multiple policies.
 
      	 [bookmark: pgfId-5376367]Click the  All Policies check box to select all policies.
 
     
 
    
 
    [bookmark: pgfId-5376368]Step 8 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-5376369]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5376370]Step 9 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5376371]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5376375]Step 10 Click Save.
 
    [bookmark: pgfId-5379785]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472412]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5375667][bookmark: 75941]Automating Software[bookmark: marker-5003423] Updates
 
    [bookmark: pgfId-5407601]License: Any
 
    [bookmark: pgfId-5368096]You can automatically download and apply most patches and feature releases to the FireSIGHT System.
 
     
      
    
 
    
 
    [bookmark: pgfId-5381894]Note You must manually upload and install updates in two situations. First, you cannot schedule major updates to the FireSIGHT System. Second, you cannot schedule updates for or pushes from appliances that cannot access the Support Site. If your appliance is not directly connected to the Internet, you should set up a proxy as described in Configuring Management Interfaces to allow it to download updates from the Support Site. For information on manually updating the FireSIGHT System, see Updating System Software.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5382415]The tasks you must schedule to install software updates vary depending on whether you are updating the Defense Center or are using a Defense Center to update managed devices. Cisco strongly recommends that you use your Defense Centers to update the devices they manage.
 
    [bookmark: pgfId-5382431]To update the Defense Center, schedule the software installation using the Install Latest Update task. To use a Defense Center to automate software updates for its managed devices, you must schedule two tasks:
 
    
 
    [bookmark: pgfId-4868989]Step 1 Push (copy) the update to managed devices using the Push Latest Update task.
 
    [bookmark: pgfId-5382392]Step 2 Install the update on managed devices using the Install Latest Update task.
 
    [bookmark: pgfId-5472435]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5499467]When scheduling updates, schedule the push and install tasks to happen in succession. That is, to automate software updates on your managed devices, you must first push the update to the device before you can install it. To automate software updates on a device group, you must select all the devices within the group. (Note that during the manual update process you do not have to push an update to managed devices before you install it. For more information, see Updating Managed Devices.)
 
     
      
    
 
    
 
    [bookmark: pgfId-5429218]Note You cannot create individual update tasks for managed devices in a clustered or stacked configuration.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-4880531]Always allow enough time between tasks for the process to complete. Tasks should be scheduled at least 30 minutes apart. For example, if you schedule a task to install an update and the update has not finished copying from the Defense Center to the device, the installation task will not succeed. However, if the scheduled installation task repeats daily, it will install the pushed update when it runs the next day.
 
    [bookmark: pgfId-5498781]Note that a task scheduled to install an update on a device group will install the update to each device within the device group simultaneously. Allow enough time for the scheduled task to complete for all the devices within the device group.
 
    [bookmark: pgfId-4791571]If you want to have more control over this process, you can use the Once option to download and install updates during off-peak hours after you learn that an update has been released.
 
    [bookmark: pgfId-4779007]See the following sections for more information:
 
     
     	 [bookmark: pgfId-4779011]Automating Software Downloads
 
     	 [bookmark: pgfId-4869008]Automating Software Pushes
 
     	 [bookmark: pgfId-4779019]Automating Software Installs
 
    
 
     
      [bookmark: pgfId-4779074][bookmark: 86279]Automating Software[bookmark: marker-4846381] Downloads
 
     [bookmark: pgfId-5368120]License: Any
 
     [bookmark: pgfId-5382242]You can create a scheduled task that automatically downloads the latest software updates from Cisco. You can use this task to schedule download of updates you plan to install manually.
 
     [bookmark: pgfId-5382247]To automate software update downloads:
 
     [bookmark: pgfId-5298226]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5368138]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-4779081]The Scheduling page appears.
 
     [bookmark: pgfId-4779082]Step 2 Click Add Task.
 
     [bookmark: pgfId-4779083]The New Task page appears.
 
     [bookmark: pgfId-4779084]Step 3 From the Job Type list, select Download Latest Update.
 
     [bookmark: pgfId-4779085]The New Task page reloads to show the update options.
 
     [bookmark: pgfId-5403264]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
      
       
       	 [bookmark: pgfId-4779095]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
       	 [bookmark: pgfId-4779096]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
      
 
     
 
     [bookmark: pgfId-4779100]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
     [bookmark: pgfId-5368143]Step 6 In the Update Items section, select Software.
 
     [bookmark: pgfId-4779125]Step 7 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-4779126]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4779127]Step 8 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
     [bookmark: pgfId-5368156]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     [bookmark: pgfId-4779132]Step 9 Click Save.
 
     [bookmark: pgfId-5379801]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
     [bookmark: pgfId-5472449]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4869180][bookmark: 73801]Automating Software[bookmark: marker-4869179] Pushes
 
     [bookmark: pgfId-5368162]License: Any
 
     [bookmark: pgfId-5381971]If you want to automate the installation of software updates on managed devices, you must push the updates to the devices before installing.
 
     [bookmark: pgfId-5381983]When you push updates to managed devices, information about the push process status is reported on the Tasks page. See Viewing the Status of Long-Running Tasks for more information.
 
     [bookmark: pgfId-5047460]When you create the task to push software updates to managed devices, make sure you allow enough time between the push task and a scheduled install task for the updates to be copied to the device.
 
     [bookmark: pgfId-4869192]To push software updates to managed devices:
 
     [bookmark: pgfId-5298306]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5368172]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-4869194]The Scheduling page appears.
 
     [bookmark: pgfId-4869195]Step 2 Click Add Task.
 
     [bookmark: pgfId-4869196]The New Task page appears.
 
     [bookmark: pgfId-4869197]Step 3 From the Job Type list, select Push Latest Update.
 
     [bookmark: pgfId-4869198]The page reloads to show the options for pushing updates.
 
     [bookmark: pgfId-4869203]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
      
       
       	 [bookmark: pgfId-4869204]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
       	 [bookmark: pgfId-4869205]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
      
 
     
 
     [bookmark: pgfId-4869209]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
     [bookmark: pgfId-4869210]Step 6 From the Device list, select the device that you want to receive updates.
 
     [bookmark: pgfId-5389551]Step 7 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-4869216]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4869217]Step 8 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
     [bookmark: pgfId-5368190]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     [bookmark: pgfId-4869222]Step 9 Click Save.
 
     [bookmark: pgfId-5379839]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
     [bookmark: pgfId-5472465]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-4779203][bookmark: 73560]Automating Software[bookmark: marker-4846383] Installs
 
     [bookmark: pgfId-5368206]License: Any
 
     [bookmark: pgfId-5288673]If you are using a Defense Center to create a task to install a software update on a managed device, make sure you allow enough time between the task that pushes the update to the device and the task that installs the update. See Automating Software Pushes for information about pushing updates to managed devices.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-5288718] 
      Caution Depending on the update being installed, the appliance may reboot after the software is installed. 
       
       
 
      
 
     
 
     [bookmark: pgfId-4779210]To schedule a software installation task:
 
     [bookmark: pgfId-5298328]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5368216]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-4779212]The Scheduling page appears.
 
     [bookmark: pgfId-4779213]Step 2 Click Add Task.
 
     [bookmark: pgfId-4779214]The New Task page appears.
 
     [bookmark: pgfId-4779215]Step 3 From the Job Type list, select Install Latest Update.
 
     [bookmark: pgfId-4779216]The page reloads to show the options for installing updates.
 
     [bookmark: pgfId-4779225]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
      
       
       	 [bookmark: pgfId-4779226]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
       	 [bookmark: pgfId-4779227]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
      
 
     
 
     [bookmark: pgfId-4779231]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
     [bookmark: pgfId-5377426]Step 6 From the Device list, you have the following options:
 
      
       
       	 [bookmark: pgfId-5377427]Select the device where you want to install the update.
 
       	 [bookmark: pgfId-5377431]Select the name of the Defense Center to install the update there.
 
      
 
     
 
     [bookmark: pgfId-4869310]Step 7 In the Update Items section, select Software.
 
     [bookmark: pgfId-4784881]Step 8 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-4779239]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-4779240]Step 9 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
     [bookmark: pgfId-5368223]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     [bookmark: pgfId-4779245]Step 10 Click Save.
 
     [bookmark: pgfId-5407511]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
     [bookmark: pgfId-5472490]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-5407517][bookmark: 47902]Automating Vulnerability Database[bookmark: marker-5407516] Updates
 
    [bookmark: pgfId-5407640]License: FireSIGHT
 
    [bookmark: pgfId-5407521]Cisco uses vulnerability database (VDB) updates to expand the list of network assets, traffic, and vulnerabilities that the FireSIGHT System recognizes. You can use the scheduling feature to download and install the latest VDB update on your Defense Centers, thereby ensuring that you are using the most up-to-date information to evaluate the hosts on your network.
 
     
      
    
 
    
 
    [bookmark: pgfId-5380597]Note You cannot schedule updates for appliances that cannot access the Support Site. If your appliance is not directly connected to the Internet, you should set up a proxy as described in Configuring Management Interfaces to allow it to download updates from the Support Site. For information on manually updating the FireSIGHT System, see Updating System Software.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5368274]When automating VDB updates, you must automate two separate steps:
 
    
 
    [bookmark: pgfId-5368275]Step 1 Downloading the VDB update.
 
    [bookmark: pgfId-5368276]Step 2 Installing the VDB update.
 
    [bookmark: pgfId-5472504]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5368296]Always allow enough time between tasks for the process to complete. For example, if you schedule a task to install an update and the update has not fully downloaded, the installation task will not succeed. However, if the scheduled installation task repeats daily, it will install the downloaded VDB update when the task runs the next day.
 
    [bookmark: pgfId-5415241]If you want to have more control over this process, you can use the Once option to download and install VDB updates during off-peak hours after you learn that an update has been released.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-5415242] 
     Caution Installing a VDB update restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-5415243]See the following sections for more information:
 
     
     	 [bookmark: pgfId-5415247]Automating VDB Update Downloads
 
     	 [bookmark: pgfId-5368310]Automating VDB Update Installs
 
    
 
     
      [bookmark: pgfId-5368313][bookmark: 30103]Automating VDB Update[bookmark: marker-5368312] Downloads
 
     [bookmark: pgfId-5382478]License: FireSIGHT
 
     [bookmark: pgfId-5382482]You can create a scheduled task on the Defense Center that automatically downloads the latest VDB update from Cisco.
 
     [bookmark: pgfId-5368338]To automate VDB update downloads:
 
     [bookmark: pgfId-5368339]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5368340]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-5368341]The Scheduling page appears.
 
     [bookmark: pgfId-5368342]Step 2 Click Add Task.
 
     [bookmark: pgfId-5368343]The New Task page appears.
 
     [bookmark: pgfId-5368344]Step 3 From the Job Type list, select Download Latest Update.
 
     [bookmark: pgfId-5368345]The New Task page reloads to show the update options.
 
     [bookmark: pgfId-5368350]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
      
       
       	 [bookmark: pgfId-5368351]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
       	 [bookmark: pgfId-5368352]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
      
 
     
 
     [bookmark: pgfId-5368356]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
     [bookmark: pgfId-5368365]Step 6 In the Update Items section, select Vulnerability Database.
 
     [bookmark: pgfId-5368367]Step 7 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-5368368]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5368369]Step 8 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
     [bookmark: pgfId-5368372]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     [bookmark: pgfId-5368374]Step 9 Click Save.
 
     [bookmark: pgfId-5379664]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
     [bookmark: pgfId-5472573]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5368454][bookmark: 57634]Automating VDB Update[bookmark: marker-5368453] Installs
 
     [bookmark: pgfId-5368465]License: FireSIGHT
 
     [bookmark: pgfId-5415368]You should allow enough time between the task that downloads the VDB update and the task that installs the update; see Automating VDB Update Downloads for information.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-5504579] 
      Caution Installing a VDB update restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-5504551]To schedule a VDB update:
 
     [bookmark: pgfId-5504532]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5368482]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-5368483]The Scheduling page appears.
 
     [bookmark: pgfId-5368484]Step 2 Click Add Task.
 
     [bookmark: pgfId-5368485]The New Task page appears.
 
     [bookmark: pgfId-5368486]Step 3 From the Job Type list, select Install Latest Update.
 
     [bookmark: pgfId-5368487]The page reloads to show the options for installing updates.
 
     [bookmark: pgfId-5368492]Step 4 Specify how you want to schedule the task, Once or Recurring:
 
      
       
       	 [bookmark: pgfId-5368493]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
       	 [bookmark: pgfId-5368494]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
      
 
     
 
     [bookmark: pgfId-5368498]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
     [bookmark: pgfId-5379502]Step 6 From the Device drop-down list, select the name of the Defense Center.
 
     [bookmark: pgfId-5379447]Step 7 In the Update Items section, select Vulnerability Database.
 
     [bookmark: pgfId-5368509]Step 8 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
      
       
     
 
     
 
     [bookmark: pgfId-5368510]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5368511]Step 9 Optionally, in the Email Status To: field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
     [bookmark: pgfId-5368514]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
     [bookmark: pgfId-5368516]Step 10 Click Save.
 
     [bookmark: pgfId-5379689]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
     [bookmark: pgfId-5472621]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-5376726][bookmark: 94523]Automating URL Filt[bookmark: marker-5407284]ering Updates
 
    [bookmark: pgfId-5376780]License: URL Filtering
 
    [bookmark: pgfId-5437324]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-5391761]You can use the scheduler to automate updates of URL filtering data from the Collective Security Intelligence Cloud. For a URL filtering update task to succeed:
 
     
     	 [bookmark: pgfId-5391876]The Defense Center must have access to the Internet or it cannot contact the cloud.
 
     	 [bookmark: pgfId-5391904]You must enable URL filtering, as described in Enabling Cloud Communications. 
 
    
 
    [bookmark: pgfId-5391826]Note that when you enable URL filtering, you can also enable automatic updates. This forces the Defense Center to contact the cloud every 30 minutes for URL filtering data updates. If you have enabled automatic updates, you should not create a scheduled task to update URL filtering data.
 
    [bookmark: pgfId-5405759]Although daily updates tend to be small, if it has been more than five days since your last update, new URL filtering data may take up to 20 minutes to download, depending on your bandwidth. Then, it may take up to 30 minutes to perform the update itself.
 
    [bookmark: pgfId-5391541]To automate URL filtering data tasks:
 
    [bookmark: pgfId-5391542]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5391543]Step 1 Select System > Tools > Scheduling. 
 
    [bookmark: pgfId-5391544]The Scheduling page appears.
 
    [bookmark: pgfId-5391545]Step 2 Click Add Task.
 
    [bookmark: pgfId-5391546]The New Task page appears.
 
    [bookmark: pgfId-5391547]Step 3 From the Job Type list, select Update URL Filtering Database.
 
    [bookmark: pgfId-5391548]The page reloads to show the URL filtering update options.
 
    [bookmark: pgfId-5391554]Step 4 Specify how you want to schedule the update, Once or Recurring:
 
     
      
      	 [bookmark: pgfId-5391555]For one-time tasks, use the drop-down lists to specify the start date and time. The  Current Time field indicates the current time on the appliance.
 
      	 [bookmark: pgfId-5391556]For recurring tasks, you have several options for setting the interval between instances of the task. See Configuring a Recurring Task for details.
 
     
 
    
 
    [bookmark: pgfId-5391561]Step 5 In the Job Name field, type a name using up to 255 alphanumeric characters, spaces, or dashes.
 
    [bookmark: pgfId-5391567]Step 6 Optionally, in the Comment field, type a comment using up to 255 alphanumeric characters, spaces, or periods.
 
     
      
    
 
    
 
    [bookmark: pgfId-5391568]Tip The comment field appears in the View Tasks section of the page, so you should try to keep it relatively short.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5391569]Step 7 Optionally, in the Email Status To field, type the email address (or multiple email addresses separated by commas) where you want task status messages sent.
 
    [bookmark: pgfId-5391570]You must have a valid email relay server configured to send status messages. See Configuring a Mail Relay Host and Notification Address for more information about configuring a relay host.
 
    [bookmark: pgfId-5391574]Step 8 Click Save.
 
    [bookmark: pgfId-5391575]The task is added. You can check the status of a running task on the Task Status page; see Viewing the Status of Long-Running Tasks.
 
    [bookmark: pgfId-5472640]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4925936][bookmark: 16954]Viewing[bookmark: marker-4925935] Tasks
 
    [bookmark: pgfId-5407689]License: Any
 
    [bookmark: pgfId-1898938]After adding scheduled tasks, you can view them and evaluate their status. The View Options section of the page allows you to view scheduled tasks using a calendar and a list of scheduled tasks. 
 
    [bookmark: pgfId-1918633]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1918650]Using the Calendar
 
     	 [bookmark: pgfId-1918686]Using the Task List
 
    
 
     
      [bookmark: pgfId-1898804][bookmark: 54729]Using the[bookmark: marker-4846396] Calendar
 
     [bookmark: pgfId-5368929]License: Any
 
     [bookmark: pgfId-1899104]The Calendar view option allows you to view which scheduled tasks occur on which day.
 
     [bookmark: pgfId-1899137]To view scheduled tasks using the calendar:
 
     [bookmark: pgfId-5298453]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5368939]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-4488722]The Scheduling page appears.
 
     [bookmark: pgfId-5041742]Step 2 You can perform the following tasks using the calendar view:
 
      
       
       	 [bookmark: pgfId-5041744]Click the double left arrow icon (
 
      
 
      [image: ] ) to move back one year. 
     
 
      
       
       	 [bookmark: pgfId-5397911]Click the single left arrow icon (
 
      
 
      [image: ] ) to move back one month. 
     
 
      
       
       	 [bookmark: pgfId-5397915]Click the single right arrow icon (
 
      
 
      [image: ] ) to move forward one month. 
     
 
      
       
       	 [bookmark: pgfId-5397918]Click the double right arrow icon (
 
      
 
      [image: ] ) to move forward one year. 
     
 
      
       
       	 [bookmark: pgfId-5041764]Click  Today to return to the current month and year.
 
       	 [bookmark: pgfId-5048165]Click  Add Task to schedule a new task.
 
       	 [bookmark: pgfId-1918548]Click a date to view all scheduled tasks for the specific date in a task list table below the calendar.
 
       	 [bookmark: pgfId-1918552]Click a specific task on a date to view the task in a task list table below the calendar.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-1918572]Note For more information about using the task list, see Using the Task List.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5472655]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1898850][bookmark: 96273]Using the[bookmark: marker-4846397] Task List
 
     [bookmark: pgfId-5368954]License: Any
 
     [bookmark: pgfId-1899386]The Task List shows a list of tasks along with their status. The task list appears below the calendar when you open the calendar. In addition, you can access it by selecting a date or task from the calendar. See Using the Calendar for more information.
 
     [bookmark: pgfId-1899403]
 
      
       
        
        [bookmark: pgfId-1899406]Table 62-1 Task List Columns 
 
        
        
         
         	 
           
           [bookmark: pgfId-1899410]Column 
          
  
         	 
           
           [bookmark: pgfId-1899412]Description 
          
  
        
 
         
         	[bookmark: pgfId-1899414]Name
  
         	[bookmark: pgfId-1899416]Displays the name of the scheduled task and the comment associated with it.
  
        
 
         
         	[bookmark: pgfId-1899418]Type
  
         	[bookmark: pgfId-1899420]Displays the type of scheduled task.
  
        
 
         
         	[bookmark: pgfId-1899422]Start Time
  
         	[bookmark: pgfId-1899424]Displays the scheduled start date and time.
  
        
 
         
         	[bookmark: pgfId-1899426]Frequency
  
         	[bookmark: pgfId-1899428]Displays how often the task is run.
  
        
 
         
         	[bookmark: pgfId-1899434]Status
  
         	[bookmark: pgfId-2108567]Describes the current status for a scheduled task: 
 
           
           	 [bookmark: pgfId-2108568]A check mark icon (
 
           [image: ] ) indicates that the task ran successfully. 
          
 
           
           	 [bookmark: pgfId-2108563]A question mark icon (
 
           [image: ] ) indicates that the task is in an unknown state. 
          
 
           
           	 [bookmark: pgfId-4655992]An exclamation mark icon (
 
           [image: ] ) indicates that the task failed. 
          
  
        
 
         
         	[bookmark: pgfId-1899438]Creator
  
         	[bookmark: pgfId-1899440]Displays the name of the user that created the scheduled task.
  
        
 
         
         	[bookmark: pgfId-5390977]Edit
  
         	[bookmark: pgfId-5390979]Edits the scheduled task.
  
        
 
         
         	[bookmark: pgfId-1899442]Delete
  
         	[bookmark: pgfId-1899444]Deletes the scheduled task.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-4656016][bookmark: 49458]Editing Scheduled [bookmark: marker-4925617]Tasks
 
    [bookmark: pgfId-5368969]License: Any
 
    [bookmark: pgfId-4925606]You can edit a scheduled task that you previously created. This feature is especially useful if you want to test a scheduled task once to make sure that the parameters are correct. Later, after the task completes successfully, you can change it to a recurring task.
 
    [bookmark: pgfId-4925477]To edit an existing scheduled task:
 
    [bookmark: pgfId-5298472]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5368979]Step 1 Select System > Tools > Scheduling. 
 
    [bookmark: pgfId-4925479]The Scheduling page appears.
 
    [bookmark: pgfId-4925480]Step 2 Click either the task that you want to edit or the day on which the task appears. 
 
    [bookmark: pgfId-4925481]The Task Details table containing the selected task or tasks appears.
 ) 
    
 
    [bookmark: pgfId-4925483]The Edit Task page appears, showing the details of the task you selected.
 
    [bookmark: pgfId-4925555]Step 4 Edit the task to meet your needs, including the start time, the job name, the comment, and how often the task runs, once or recurring. You cannot change the type of job.
 
    [bookmark: pgfId-4951420]The remaining options are determined by the task you are editing. See the following sections for more information:
 
     
      
      	 [bookmark: pgfId-5384473]Automating Backup Jobs
 
      	 [bookmark: pgfId-5384477]Automating Certificate Revocation List Downloads
 
      	 [bookmark: pgfId-5384481]Automating Nmap Scans
 
      	 [bookmark: pgfId-5384485]Automating Report Generation
 
      	 [bookmark: pgfId-5384489]Automating FireSIGHT Recommendations
 
      	 [bookmark: pgfId-5384493]Automating Software Updates
 
      	 [bookmark: pgfId-5384497]Automating Vulnerability Database Updates
 
      	 [bookmark: pgfId-5384501]Automating URL Filtering Updates
 
     
 
    
 
    [bookmark: pgfId-4925583]Step 5 Click Save to save your edits.
 
    [bookmark: pgfId-4925590]Your change are saved and the Scheduling page appears again.
 
    [bookmark: pgfId-5472669]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4925447][bookmark: 49144]Deleting Scheduled[bookmark: marker-4846398] Tasks
 
    [bookmark: pgfId-5407725]License: Any
 
    [bookmark: pgfId-1918190]There are two types of deletions you can perform from the Schedule View page. You can delete a specific one-time task that has not yet run or you can delete every instance of a recurring task. If you delete an instance of a recurring task, all instances of the task are deleted. If you delete a task that is scheduled to run once, only that task is deleted.
 
    [bookmark: pgfId-2109444]The following sections describe how to delete tasks:
 
     
     	 [bookmark: pgfId-2109461]To delete all instances of a task, see Deleting a Recurring Task.
 
     	 [bookmark: pgfId-2109489]To delete a single instance of a task, see Deleting a One-Time Task.
 
    
 
     
      [bookmark: pgfId-2109502][bookmark: 75002]Deleting a Recurring Task
 
     [bookmark: pgfId-5369022]License: Any
 
     [bookmark: pgfId-2109590]When you delete one instance of a recurring task, you automatically delete all instances of that task.
 
     [bookmark: pgfId-1918238]To delete a recurring task:
 
     [bookmark: pgfId-5298487]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5369032]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-4488736]The Scheduling page appears.
 
     [bookmark: pgfId-1918262]Step 2 On the calendar, select an instance of the recurring task you want to delete.
 
     [bookmark: pgfId-1918266]The page reloads to display a table of tasks below the calendar.
 ). 
     
 
     [bookmark: pgfId-1918295]All instances of the recurring task are deleted.
 
     [bookmark: pgfId-5472683]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-1918316][bookmark: 58447]Deleting a One-Time Task
 
     [bookmark: pgfId-5369047]License: Any
 
     [bookmark: pgfId-2109562]You can delete a one-time scheduled task or delete the record of a previously run scheduled task using the task list.
 
     [bookmark: pgfId-2109599]To delete a single task or, if it has already run, delete a task record:
 
     [bookmark: pgfId-5298501]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5369057]Step 1 Select System > Tools > Scheduling. 
 
     [bookmark: pgfId-4488741]The Scheduling page appears.
 
     [bookmark: pgfId-1918397]Step 2 Click the task that you want to delete or the day on which the task appears. 
 
     [bookmark: pgfId-4558198]A table containing the selected task or tasks appears.
 ). 
     
 
     [bookmark: pgfId-1918466]The instance of the task you selected is deleted.
 
     [bookmark: pgfId-5472692]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2514234]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7820487][bookmark: 78653]Managing Syste[bookmark: marker-7820486]m Policies 
      
      
 
     
 
 
    [bookmark: pgfId-8182312]A system policy allows you to manage the following on your FireSIGHT System appliances:
 
     
     	 [bookmark: pgfId-7820497]access control preferences
 
     	 [bookmark: pgfId-8079763]appliance access lists
 
     	 [bookmark: pgfId-7820498]audit log settings
 
     	 [bookmark: pgfId-8211512]external authentication
 
     	 [bookmark: pgfId-7820500]dashboard settings
 
     	 [bookmark: pgfId-7820501]database event limits
 
     	 [bookmark: pgfId-7820503]DNS cache properties
 
     	 [bookmark: pgfId-7866517]the mail relay host and notification address
 
     	 [bookmark: pgfId-7866518]tracking intrusion and network analysis policy changes 
 
     	 [bookmark: pgfId-7866519]specifying a different language
 
     	 [bookmark: pgfId-7820506]custom login banners
 
     	 [bookmark: pgfId-7820515]SNMP polling settings
 
     	 [bookmark: pgfId-7958724]synchronizing time
 
     	 [bookmark: pgfId-8145003]STIG compliance
 
     	 [bookmark: pgfId-7820519]serving time from the Defense Center
 
     	 [bookmark: pgfId-8120477]user interface and command line interface timeout settings
 
     	 [bookmark: pgfId-7958687]mapping vulnerabilities for servers
 
    
 
    [bookmark: pgfId-7820524]You can use a system policy to control the aspects of your Defense Center that are likely to be similar for other appliances in your deployment. For example, your organization’s security policies may require that your appliances have a “No Unauthorized Use” message when a user logs in. With system policies, you can set the login banner once in a system policy on a Defense Center and then apply the policy to all the devices that it manages.
 
    [bookmark: pgfId-7820534]You can also benefit from having multiple system policies on a Defense Center. For example, if you have different mail relay hosts that you use under different circumstances or if you want to test different database limits, you can create several system policies and switch between them, rather than editing a single policy.
 
    [bookmark: pgfId-8231926]Contrast a system policy, which controls aspects of an appliance that are likely to be similar across a deployment, with system settings, which are likely to be specific to a single appliance. See Configuring Appliance Settings for more information.
 
    [bookmark: pgfId-8231930]See the following sections for more information:
 
     
     	 [bookmark: pgfId-8231934]Creating a System Policy
 
     	 [bookmark: pgfId-7820548]Editing a System Policy
 
     	 [bookmark: pgfId-7820552]Applying a System Policy
 
     	 [bookmark: pgfId-8022553]Comparing System Policies
 
     	 [bookmark: pgfId-7820556]Deleting System Policies
 
    
 
   
 
    
     [bookmark: pgfId-8231949][bookmark: 99111]Creating a System [bookmark: marker-8231948]Policy
 
    [bookmark: pgfId-8231990]License: Any
 
    [bookmark: pgfId-8231997]Supported Devices: Any except X-Series
 
    [bookmark: pgfId-8231999]When you create a system policy, you assign it a name and a description. Next, you configure the various aspects of the policy, each of which is described in its own section. 
 
    [bookmark: pgfId-7876165]Instead of creating a new policy, you can export a system policy from another appliance and then import it onto your appliance. You can then edit the imported policy to suit your needs before you apply it. For more information, see Importing and Exporting Configurations.
 
    [bookmark: pgfId-7820580]To create a system policy:
 
    [bookmark: pgfId-7820581]Access: Admin
 
    
 
    [bookmark: pgfId-7820582]Step 1 Select System > Local > System Policy.
 
    [bookmark: pgfId-7820583]The System Policy page appears.
 
    [bookmark: pgfId-7820588]The Policy Name column includes the system policy’s description. The Applied To column indicates the number of appliances where the policy is applied and a count of out-of-date appliances where the previously applied policy has changed and should be reapplied.
 
    [bookmark: pgfId-7820589]Step 2 Click Create Policy.
 
    [bookmark: pgfId-7820590]The Create Policy page appears.
 
    [bookmark: pgfId-7820595]Step 3 From the drop-down list, select an existing policy to use as a template for your new system policy.
 
    [bookmark: pgfId-8051591]Step 4 Type a name for your new policy in the New Policy Name field.
 
    [bookmark: pgfId-8051612]Step 5 Type a description for your new policy in the New Policy Description field.
 
    [bookmark: pgfId-8051593]Step 6 Click Create.
 
    [bookmark: pgfId-7820598]Your system policy is saved and the Edit System Policy page appears. For information about configuring each aspect of the system policy, see one of the following sections:
 
     
      
      	 [bookmark: pgfId-7820602]Configuring the Access List for Your Appliance
 
      	 [bookmark: pgfId-7820606]Configuring Audit Log Settings
 
      	 [bookmark: pgfId-8211533]Enabling External Authentication
 
      	 [bookmark: pgfId-7820614]Configuring Dashboard Settings
 
      	 [bookmark: pgfId-7820618]Configuring Database Event Limits
 
      	 [bookmark: pgfId-7820626]Configuring DNS Cache Properties
 
      	 [bookmark: pgfId-7820630]Configuring a Mail Relay Host and Notification Address
 
      	 [bookmark: pgfId-8048932]Configuring Access Control Policy Preferences
 
      	 [bookmark: pgfId-8219477]Configuring Network Analysis Policy Preferences
 
      	 [bookmark: pgfId-7820634]Configuring Intrusion Policy Preferences
 
      	 [bookmark: pgfId-7842464]Specifying a Different Language
 
      	 [bookmark: pgfId-7820638]Adding a Custom Login Banner
 
      	 [bookmark: pgfId-7994301]Configuring SNMP Polling
 
      	 [bookmark: pgfId-7820654]Enabling STIG Compliance
 
      	 [bookmark: pgfId-8145030]Synchronizing Time
 
      	 [bookmark: pgfId-7820658]Serving Time from the Defense Center
 
      	 [bookmark: pgfId-8120519]Configuring User Interface Settings
 
      	 [bookmark: pgfId-7820662]Mapping Vulnerabilities for Servers
 
     
 
    
 
    [bookmark: pgfId-8195329]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7820678][bookmark: 86555]Editing a System Pol[bookmark: marker-7820677]icy
 
    [bookmark: pgfId-8075158]License: Any
 
    [bookmark: pgfId-8232004]Supported Devices: Any except X-Series
 
    [bookmark: pgfId-7820681]You can edit an existing system policy. If you edit a system policy that is currently applied to an appliance, reapply the policy after you have saved your changes. For more information, see Applying a System Policy.
 
    [bookmark: pgfId-7820685]To edit an existing system policy:
 
    [bookmark: pgfId-7820686]Access: Admin
 
    
 
    [bookmark: pgfId-8036145]Step 1 Select System > Local > System Policy.
 
    [bookmark: pgfId-7820688]The System Policy page appears, including a list of the existing system policies.
 ) next to the system policy that you want to edit. 
    
 
    [bookmark: pgfId-7820690]The Edit Policy page appears. You can change the policy name and policy description. For information about configuring each aspect of the system policy, see one of the following sections:
 
     
      
      	 [bookmark: pgfId-8080185]Configuring Access Control Policy Preferences
 
      	 [bookmark: pgfId-7820694]Configuring the Access List for Your Appliance
 
      	 [bookmark: pgfId-7820698]Configuring Audit Log Settings
 
      	 [bookmark: pgfId-8211557]Enabling External Authentication
 
      	 [bookmark: pgfId-7820706]Configuring Dashboard Settings
 
      	 [bookmark: pgfId-7820710]Configuring Database Event Limits
 
      	 [bookmark: pgfId-7820718]Configuring DNS Cache Properties
 
      	 [bookmark: pgfId-7820722]Configuring a Mail Relay Host and Notification Address
 
      	 [bookmark: pgfId-8220468]Configuring Network Analysis Policy Preferences
 
      	 [bookmark: pgfId-7820726]Configuring Intrusion Policy Preferences
 
      	 [bookmark: pgfId-7837889]Specifying a Different Language
 
      	 [bookmark: pgfId-7820730]Adding a Custom Login Banner
 
      	 [bookmark: pgfId-7994314]Configuring SNMP Polling
 
      	 [bookmark: pgfId-7820746]Synchronizing Time
 
      	 [bookmark: pgfId-7820750]Serving Time from the Defense Center
 
      	 [bookmark: pgfId-8120550]Configuring User Interface Settings
 
      	 [bookmark: pgfId-7820754]Mapping Vulnerabilities for Servers
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7820755]Note If you are editing a system policy applied to an appliance, make sure you reapply the updated policy when you are finished. See Applying a System Policy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8051864]Step 3 Click Save Policy and Exit to save your changes. The changes are saved, and the System Policy page appears.
 
    [bookmark: pgfId-8195340]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8052860][bookmark: 80463]Applying a System P[bookmark: marker-8052859]olicy
 
    [bookmark: pgfId-8144720]License: Any
 
    [bookmark: pgfId-8232036]Supported Devices: Any except X-Series
 
    [bookmark: pgfId-8144859]You can apply a system policy to an appliance. If a system policy is already applied, any changes you make do not take effect until you reapply it.
 
     
      
    
 
    
 
    [bookmark: pgfId-8149446]Note You cannot apply a system policy to Cisco NGIPS for Blue Coat X-Series.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8144817]To apply a system policy:
 
    [bookmark: pgfId-7820774]Access: Admin
 
    
 
    [bookmark: pgfId-8036164]Step 1 Select System > Local > System Policy.
 
    [bookmark: pgfId-7820776]The System Policy page appears.
 ) next to the system policy that you want to apply. 
    
 
    [bookmark: pgfId-8089720]The Apply page appears.
 
    [bookmark: pgfId-7820793]Step 3 Select the appliances to which you want to apply the system policy.
 
     
      
    
 
    
 
    [bookmark: pgfId-7820794]Tip You can sort the appliances by group, model, health policy, or applied system policy. You can select either an individual appliance or an entire group.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7820795]Step 4 Click Apply.
 
    [bookmark: pgfId-7820796]The System Policy page appears. A message indicates the status of applying the system policy.
 
    [bookmark: pgfId-8195356]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-8022174][bookmark: 15454]Comparing System Policies
 
     [bookmark: pgfId-8022176]License: Any
 
     [bookmark: pgfId-8232068]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8025280]You can compare two system policies or two revisions of the same system policy, subject to the system policies you can access. This allows you to review policy changes for compliance with your organization’s standards, or for optimization of system performance. To quickly compare your active system policy to another, you can select the Running Configuration option. Optionally, after you compare, you can generate a PDF report to record the differences between the system policies or system policy revisions.
 
     [bookmark: pgfId-8022178]There are two tools you can use to compare system policies or system policy revisions:
 
      
      	 [bookmark: pgfId-8022179]The comparison view displays the differences between two system policies or system policy revisions in a side-by-side format. The name of each policy or policy revision appears in the title bar on the left and right sides of the comparison view.
 
     
 
     [bookmark: pgfId-8022180]You can use this to view and navigate both policy revisions on the web interface, with their differences highlighted.
 
      
      	 [bookmark: pgfId-8022181]The comparison report creates a record of the differences between two system policies or system policy revisions in a format similar to the system policy report, but in PDF format.
 
     
 
     [bookmark: pgfId-8022182]You can use this to save, copy, print, and share your policy comparisons for further examination.
 
    
 
     
      [bookmark: pgfId-8037982][bookmark: 76698]Using the System Policy Comparison View
 
     [bookmark: pgfId-8037987]License: Any
 
     [bookmark: pgfId-8232171]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8022202]The comparison view displays both system policies or policy revisions in a side-by-side format, with each policy or policy revision identified by name in the title bar on the left and right sides of the comparison view. For all revisions, the system policy comparison view displays the time of last modification and the last user to the right of the policy name.
 
     [bookmark: pgfId-8022204]Differences between the two system policies or policy revisions are highlighted:
 
      
      	 [bookmark: pgfId-8022205]Blue indicates that the highlighted setting is different in the two policies or policy revisions, and the difference is noted in red text.
 
      	 [bookmark: pgfId-8022206]Green indicates that the highlighted setting appears in one policy or policy revision, but not the other.
 
     
 
      
       
        
        [bookmark: pgfId-8076232]Table 63-1 [bookmark: 48218]System Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-8076236]To... 
          
  
         	 
           
           [bookmark: pgfId-8076238]You can... 
          
  
        
 
         
         	[bookmark: pgfId-8076240]navigate individually through changes
  
         	[bookmark: pgfId-8076242]select Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-8076248]generate a new system policy comparison view
  
         	[bookmark: pgfId-8076250]select New Comparison.
 [bookmark: pgfId-8076251]The Select Comparison window appears. See Using the System Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-8076256]generate a system policy comparison report
  
         	[bookmark: pgfId-8076258]select Comparison Report. 
 [bookmark: pgfId-8076259]The system policy comparison report is a PDF that contains information identical to the system policy comparison view.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-8076294][bookmark: 72816]Using the System Policy Comparison Report
 
     [bookmark: pgfId-8022252]License: Any
 
     [bookmark: pgfId-8232231]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8075454]A system policy comparison report is a record of all differences between two system policies or two revisions of the same system policy identified by the system policy comparison view, presented in PDF format. You can use this report to further examine the differences between two system policy configurations and to save and disseminate your findings.
 
     [bookmark: pgfId-8075455]You can generate a system policy comparison report from the comparison view for any system policies to which you have access. Changes you make to a system policy do not appear in the system policy comparison report until you save the changes. 
 
     [bookmark: pgfId-8054622]Depending on your configuration, a system policy comparison report can contain one or more sections. Each section uses the same format and provides the same level of detail. Note that the Value A and Value B columns represent the policies or policy revisions you configured in the comparison view.
 
      
       
     
 
     
 
     [bookmark: pgfId-8220725]Tip You can use a similar procedure to compare SSL, network analysis, intrusion, file, access control, or health policies.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8025124][bookmark: 88322]To compare two system policies or two revisions of the same policy:
 
     [bookmark: pgfId-8022259]Access: Admin
 
     
 
     [bookmark: pgfId-8036192]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-8022261]The System Policy page appears.
 
     [bookmark: pgfId-8022262]Step 2 Click Compare Policies.
 
     [bookmark: pgfId-8022263]The Select Comparison pop-up window appears.
 
     [bookmark: pgfId-8022264]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make: 
 
      
       
       	 [bookmark: pgfId-8025206]To compare two different policies, select  Other Policy .
 
       	 [bookmark: pgfId-8025207]To compare two revisions of the same policy, select  Other Revision .
 
       	 [bookmark: pgfId-8054975]To compare another policy to a currently active policy, select  Running Configuration. 
 
      
 
     
 
     [bookmark: pgfId-8054977]Step 4 Depending on the comparison type you selected, you have the following choices:
 
      
       
       	 [bookmark: pgfId-8022266]If you are comparing two different policies, select the policies you want to compare from the  Policy A  and  Policy B  drop-down lists.
 
       	 [bookmark: pgfId-8022267]If you are comparing two revisions of the same policy, select the policy from the  Policy drop-down list, then select the revisions you want to compare from the  Revision A  and  Revision B  drop-down lists.
 
       	 [bookmark: pgfId-8066436]If you are comparing a running configuration to another policy, select the running configuration from the  Target/Running Configuration A drop-down list, and the other policy from the  Policy B  drop-down list.
 
      
 
     
 
     [bookmark: pgfId-8066437]Step 5 Click OK to display the system policy comparison view.
 
     [bookmark: pgfId-8022270]The comparison view appears.
 
     [bookmark: pgfId-8022272]Step 6 Click Comparison Report to generate the system policy comparison report. 
 
     [bookmark: pgfId-8022276]The system policy comparison report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
     [bookmark: pgfId-8195376]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7820811][bookmark: 78405]Deleting System Polic[bookmark: marker-7820810]ies
 
    [bookmark: pgfId-7962906]License: Any
 
    [bookmark: pgfId-8232316]Supported Devices: Any except X-Series
 
    [bookmark: pgfId-7820813]You can delete a system policy, even if it is in use. If the policy is still in use, it is used until a new policy is applied. Default system policies cannot be deleted.
 
    [bookmark: pgfId-7820814]To delete a system policy:
 
    [bookmark: pgfId-7820815]Access: Admin
 
    
 
    [bookmark: pgfId-8036218]Step 1 Select System > Local > System Policy.
 
    [bookmark: pgfId-7820817]The System Policy page appears.
 
    
 
    [bookmark: pgfId-8066476]The System Policy page appears. A pop-up message appears, confirming the policy deletion.
 
    [bookmark: pgfId-8195400]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7891831]Configuring a System Policy
 
    [bookmark: pgfId-7962913]License: Any
 
    [bookmark: pgfId-8232337]Supported Devices: Any except X-Series
 
    [bookmark: pgfId-7891870]You can configure various system policy settings. For information about configuring each aspect of the system policy, see one of the following sections:
 
     
      
      	 [bookmark: pgfId-8080093]Configuring Access Control Policy Preferences
 
      	 [bookmark: pgfId-7891874]Configuring the Access List for Your Appliance
 
      	 [bookmark: pgfId-7891878]Configuring Audit Log Settings
 
      	 [bookmark: pgfId-8211581]Enabling External Authentication
 
      	 [bookmark: pgfId-7891886]Configuring Dashboard Settings
 
      	 [bookmark: pgfId-7891890]Configuring Database Event Limits
 
      	 [bookmark: pgfId-7891898]Configuring DNS Cache Properties
 
      	 [bookmark: pgfId-7891902]Configuring a Mail Relay Host and Notification Address
 
      	 [bookmark: pgfId-8220486]Configuring Network Analysis Policy Preferences
 
      	 [bookmark: pgfId-7891906]Configuring Intrusion Policy Preferences
 
      	 [bookmark: pgfId-7891910]Specifying a Different Language
 
      	 [bookmark: pgfId-7891914]Adding a Custom Login Banner
 
      	 [bookmark: pgfId-7891930]Synchronizing Time
 
      	 [bookmark: pgfId-7891934]Serving Time from the Defense Center
 
      	 [bookmark: pgfId-8120572]Configuring User Interface Settings
 
      	 [bookmark: pgfId-7891938]Mapping Vulnerabilities for Servers
 
     
 
    
 
     
      [bookmark: pgfId-8079970][bookmark: 37585]Configuring Access Cont[bookmark: marker-8079968]rol Policy Preferences
 
     [bookmark: pgfId-8079975]License: Protection
 
     [bookmark: pgfId-8232358]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8079976]You can configure the system to prompt users for a comment when they add or modify a rule in an access control policy, prompting them to enter a rule comment. You can use this to track users’ reasons for policy changes. If you enable comments on access control rule changes, you can make the rule comment optional or mandatory. The system prompts the user for a comment when each new change to a rule is saved.
 
     [bookmark: pgfId-8079977]The system adds the comment to the rule’s comment history when the user saves the rule. For more information, see Adding Comments to a Rule.
 
     [bookmark: pgfId-8079981]To configure the access control policy rule comment settings:
 
     [bookmark: pgfId-8079982]Access: Admin
 
     
 
     [bookmark: pgfId-8079983]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-8079984]The System Policy page appears.
 
     [bookmark: pgfId-8079985]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8079986]To modify the access control policy settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-8079990]To configure the access control policy settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-8079991]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-8079995]In either case, the Access List page appears.
 
     [bookmark: pgfId-8079996]Step 3 Click Access Control Preferences.
 
     [bookmark: pgfId-8079997]The Access Control Preferences page appears.
 
     [bookmark: pgfId-8080002]Step 4 You have the following options:
 
      
       
       	 [bookmark: pgfId-8080003]Select  Disabled from the drop-down list to allow users to add or modify a rule in an access control policy without entering a comment. 
 
       	 [bookmark: pgfId-8081086]Select  Optional from the drop-down list to display the Description of Changes (Optional) window to users when they save changes to access control policy rules. This allows users the option to describe changes in a comment.
 
       	 [bookmark: pgfId-8081087]Select  Required from the drop-down list to display the Description of Changes (Required) window to users when they save changes to access control policy rules. This requires users to describe changes in a comment before the changes are saved.
 
      
 
     
 
     [bookmark: pgfId-8080006]Step 5 Click Save Policy and Exit.
 
     [bookmark: pgfId-8080007]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195599]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7820835][bookmark: 84330]Configuring the [bookmark: marker-7820833]Access List for Your Appliance
 
     [bookmark: pgfId-8076461]License: Any
 
     [bookmark: pgfId-8232383]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7820838]The Access List page allows you to control which computers can access your appliance on specific ports. By default, port 443 (Hypertext Transfer Protocol Secure, or HTTPS), which is used to access the web interface, and port 22 (Secure Shell, or SSH), which is used to access the command line, are enabled for any IP address. You can also add SNMP access over port 161. Note that you must add SNMP access for any computer you plan to use to poll for SNMP information. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7820839] 
      Caution By default, access to the appliance is 
      not restricted. To operate the appliance in a more secure environment, consider adding access to the appliance for specific IP addresses and then deleting the default 
      any option. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7820840]The access list is part of the system policy. You can specify the access list either by creating a new system policy or by editing an existing system policy. In either case, the access list does not take effect until you apply the system policy.
 
     [bookmark: pgfId-8080775]Note that this access list does not also control external database access. For more information on the external database access list, see Enabling Access to the Database.
 
     [bookmark: pgfId-7820841]To configure the access list:
 
     [bookmark: pgfId-7820842]Access: Admin
 
     
 
     [bookmark: pgfId-8036237]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7820844]The System Policy page appears.
 
     [bookmark: pgfId-7820845]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7820846]To modify the access list in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7820847]To configure the access list as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7820848]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7820852]In either case, the Access List page appears.
 ). 
     
 
     [bookmark: pgfId-8003701]The setting is removed.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7820858] 
      Caution If you delete access for the IP address that you are currently using to connect to the appliance interface, and there is no entry for “ 
      IP=any port=443”, you will lose access to the system when you apply the policy. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7820860]Step 4 Optionally, to add access for one or more IP addresses, click Add Rules.
 
     [bookmark: pgfId-7955869]The Add IP Address page appears.
 
     [bookmark: pgfId-8003719]Step 5 In the IP Address field, you have the following options, depending on the IP addresses you want to add: 
 
      
       
       	 [bookmark: pgfId-7820867]an exact IP address (for example,  192.168.1.101 )
 
       	 [bookmark: pgfId-7922070]an IP address block using CIDR notation (for example,  192.168.1.1/24 )
 
      
 
     
 
     [bookmark: pgfId-7922071]For information on using CIDR in the FireSIGHT System, see IP Address Conventions.
 
      
       
       	 [bookmark: pgfId-7922072] any , to designate any IP address
 
      
 
     
 
     [bookmark: pgfId-7820870]Step 6 Select SSH, HTTPS, SNMP, or a combination of these options to specify which ports you want to enable for these IP addresses.
 
     [bookmark: pgfId-8055969]Step 7 Click Add.
 
     [bookmark: pgfId-7820871]The Access List page appears again, reflecting the changes you made. 
 
     [bookmark: pgfId-7820873]Step 8 Click Save Policy and Exit.
 
     [bookmark: pgfId-7820874]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195583]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7820940][bookmark: 68211]Configuring A[bookmark: marker-7891172]udit Log Settings
 
     [bookmark: pgfId-7963032]License: Any
 
     [bookmark: pgfId-8232412]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7820943]You can configure the system policy so that the appliance streams an audit log to an external host.
 
      
       
     
 
     
 
     [bookmark: pgfId-7820944]Note You must ensure that the external host is functional and accessible from the appliance sending the audit log.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7820945]The sending host name is part of the information sent. You can further identify the audit log stream with a facility, a severity, and an optional tag. The appliance does not send the audit log until you apply the system policy.
 
     [bookmark: pgfId-8072839]After you apply a policy with this feature enabled, and your destination host is configured to accept the audit log, the syslog messages are sent. The following is an example of the output structure:
 
     [bookmark: pgfId-8072840]Date Time Host [Tag] Sender: [User_Name]@[User_IP], [Subsystem], [Action]
 
     [bookmark: pgfId-8072841]where the local date, time, and hostname precede the bracketed optional tag, and the sending device name precedes the audit log message. 
 
     [bookmark: pgfId-8072842]For example:
 
     [bookmark: pgfId-8072843]Mar 01 14:45:24 localhost [TAG] Dev-DC3000: admin@10.1.1.2, Operations > Monitoring, Page View
 
     [bookmark: pgfId-7820946]To configure the audit log settings:
 
     [bookmark: pgfId-7820947]Access: Admin
 
     
 
     [bookmark: pgfId-8036251]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7820949]The System Policy page appears.
 
     [bookmark: pgfId-7820950]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7820951]To modify the audit log settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7820952]To configure the audit log settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7820953]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7820957]In either case, the Access List page appears.
 
     [bookmark: pgfId-7820958]Step 3 Click Audit Log Settings.
 
     [bookmark: pgfId-8126571]The Audit Log Settings page appears.
 
     [bookmark: pgfId-8126573]Step 4 Select Enabled from the Send Audit Log to Syslog drop-down menu. (The default setting is Disabled.)
 
     [bookmark: pgfId-7820961]Step 5 Designate the destination host for the audit information by using the IP address or the fully qualified name of the host in the Host field. The default port (514) is used. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8056118] 
      Caution If the computer you configure to receive an audit log is not set up to accept remote messages, the host will not accept the audit log. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8056119]Step 6 Select a syslog facility from the Facility field.
 
     [bookmark: pgfId-8056120]Step 7 Select a severity from the Severity field. 
 
     [bookmark: pgfId-7820965]Step 8 Optionally, insert a reference tag in the Tag (optional) field.
 
     [bookmark: pgfId-8126649]Step 9 To send regular audit log updates to an external HTTP server, select Enabled from the Send Audit Log to HTTP Server drop-down list. The default setting is Disabled.
 
     [bookmark: pgfId-8126887]Step 10 In the URL to Post Audit field, designate the URL where you want to send audit information. You must enter an URL that corresponds to a listener program that expects the HTTP POST variables as listed:
 
      
       
       	 [bookmark: pgfId-8127494] subsystem 
 
       	 [bookmark: pgfId-8127538] actor 
 
       	 [bookmark: pgfId-8127545] event_type 
 
       	 [bookmark: pgfId-8127562] message 
 
       	 [bookmark: pgfId-8127571] action_source_ip 
 
       	 [bookmark: pgfId-8127589] action_destination_ip 
 
       	 [bookmark: pgfId-8127612] result 
 
       	 [bookmark: pgfId-8127621] time 
 
       	 [bookmark: pgfId-8127630] tag (if defined, as above)
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8127128] 
      Caution To allow encrypted posts, you must use an HTTPS URL. Note that sending audit information to an external URL may affect system performance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7820966]Step 11 Click Save Policy and Exit.
 
     [bookmark: pgfId-8167784]The system policy is updated. Your changes do not take effect until you apply the system policy to the Defense Center and its managed devices. See Applying a System Policy for more information. 
 
     [bookmark: pgfId-8195629]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8211610][bookmark: 73416]Enabling[bookmark: marker-8211608] External Authentication
 
     [bookmark: pgfId-8048729]License: Any
 
     [bookmark: pgfId-8232445]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7821058]Normally, when a user logs into an appliance, the appliance verifies user credentials by comparing the credentials to a user account stored in the appliance’s local database. However, if you create an authentication object referencing an external authentication server, you can enable external authentication in the system policy to let users logging into the Defense Center or managed device authenticate to that server, rather than using the local database.
 
     [bookmark: pgfId-7821065]When you apply a system policy with external authentication enabled to an appliance, the appliance verifies the user credentials against users on an LDAP or RADIUS server. In addition, if a user has local, internal authentication enabled and the user credentials are not found in the internal database, the appliance then checks the external server for a set of matching credentials. If a user has the same username on multiple systems, all passwords across all servers work. Note, however, that if authentication fails on the available external authentication servers, the appliance does not revert to checking the local database.
 
     [bookmark: pgfId-8167948]When you enable external authentication, you can set the default user role for any user whose account is externally authenticated. You can select multiple roles, as long as those roles can be combined. For example, if you enable external authentication that retrieves only users in the Network Security group in your company, you may set the default user role to include the Security Analyst role so users can access collected event data without any additional user configuration on your part. However, if your external authentication retrieves records for other personnel in addition to the security group, you would probably want to leave the default role unselected. For more information on available user roles, see Understanding User Privileges. 
 
     [bookmark: pgfId-8168081]If no access role is selected, users can log in but cannot access any functionality. After a user attempts to log in, their account is listed on the User Management page, where you can edit the account settings to grant additional permissions. For more information on modifying a user account, see Modifying User Privileges and Options.
 
      
       
     
 
     
 
     [bookmark: pgfId-8211763]Tip If you configure the system policy to use one user role and apply the policy, then later modify the policy to use different default user roles and reapply, any user accounts created before the modification retain the first user role until you modify the accounts, or delete and recreate them.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8211764]If you want to specify the set of users who can successfully authenticate against the LDAP server for shell access, you must set the shell access attribute and other settings within an LDAP authentication object before enabling external authentication in a system policy. For more information, see Configuring LDAP-Specific Parameters and Understanding Shell Access.
 
     [bookmark: pgfId-8215681]If you want to specify the set of users who can successfully authenticate against the LDAP server for CAC authentication and authorization, you must set the UI access attribute, user name template, and other settings in an LDAP authentication object before you enable external authentication in a system policy. For more information, see Configuring LDAP-Specific Parameters and Understanding LDAP Authentication With CAC.
 
      
       
     
 
     
 
     [bookmark: pgfId-8211778]Note If you want to enable both shell access and CAC authentication on an appliance, you must create separate authentication objects and enable them separately in your system policy.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8173672]After you finish customizing your authentication object, you must enable external authentication in a system policy on your Defense Center and then push that policy to managed devices. After you apply the policy to a device, eligible externally authenticated users can log into that device. To make changes to your external authentication settings, you have to modify the system policy on the Defense Center, and then apply the policy to the device again. To disable authentication on a managed device, you can disable it in a system policy on the Defense Center and push that to the device.
 
     [bookmark: pgfId-8149454]Note that you can only enable external authentication on physical and virtual Defense Centers and managed devices. Enabling external authentication by applying a system policy is not supported on Cisco NGIPS for Blue Coat X-Series.
 
     [bookmark: pgfId-7821115]If a user with internal authentication attempts to log in, the appliance first checks if that user is in the local user database. If the user exists, the appliance then checks the username and password against the local database. If a match is found, the user logs in successfully. If the login fails, however, and external authentication is enabled, the appliance checks the user against each external authentication server in the authentication order shown in the system policy. If the username and password match results from an external server, the appliance changes the user to an external user with the default privileges for that authentication object.
 
     [bookmark: pgfId-8167725]If an external user attempts to log in, the appliance checks the username and password against the external authentication server. If a match is found, the user logs in successfully. If the login fails, the user login attempt is rejected. External users cannot authenticate against the user list in the local database. If the user is a new external user, an external user account is created in the local database with the default privileges from the external authentication object.
 
     [bookmark: pgfId-7821117]To enable authentication of users on external servers:
 
     [bookmark: pgfId-7821118]Access: Admin
 
     
 
     [bookmark: pgfId-8036264]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7821123]The System Policy page appears.
 
     [bookmark: pgfId-7821124]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7821125]To modify your external authentication settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7821126]To configure your external authentication settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7821127]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-8165428]In either case, the Access List page appears.
 
     [bookmark: pgfId-8165429]Step 3 Click External Authentication.
 
     [bookmark: pgfId-8165430]The External Authentication page appears.
 
     [bookmark: pgfId-7949282]Step 4 From the Status drop-down list, select Enabled.
 
     [bookmark: pgfId-7821139]Step 5 From the Default User Role drop-down list, select user roles to define the default permissions you want to grant to externally authenticated users. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7949392]Tip Press Ctrl before selecting roles to select multiple default user roles. Note that although you can select both a Security Analyst role and the corresponding Security Analyst (Read Only) role, only the Security Analyst role is applied. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8216079]Step 6 [bookmark: 94296]If you want to use the external server to authenticate shell access accounts as well, select Enabled from the Shell Authentication drop-down list.
 
     [bookmark: pgfId-8216081]Step 7 [bookmark: 60811]If you want to enable CAC authentication and authorization, select an available CAC authentication object from the CAC Authentication drop-down list. 
 
     [bookmark: pgfId-8211909]For the complete procedure for configuring CAC authentication and authorization, see Understanding LDAP Authentication With CAC.
 
     [bookmark: pgfId-8211911]Step 8 To enable use of a preconfigured authentication object, select the check box next to the object. You must select at least one authentication object to enable external authentication.
 
      
       
     
 
     
 
     [bookmark: pgfId-8211915]Tip If you enabled shell authentication in step 6, you must select an authentication object configured to allow shell access. Note that you must use different authentication objects to manage shell access and CAC authentication in the same system policy. For more information, see Understanding Shell Access and Understanding LDAP Authentication With CAC.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8211922]Step 9 Optionally, use the up and down arrows to change the order in which authentication servers are accessed when an authentication request occurs. 
 
      
       
     
 
     
 
     [bookmark: pgfId-8211923]Note Remember that shell access users can only authenticate against the server whose authentication object is highest in the profile order.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7821145]Step 10 Click Save Policy and Exit.
 
     [bookmark: pgfId-7821146]The system policy is updated. Your changes do not take effect until you apply the system policy to the Defense Center and its managed devices. See Applying a System Policy for more information. 
 
     [bookmark: pgfId-8195695]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7821215][bookmark: 25279]Configuring Dashboard[bookmark: marker-7891189] Settings
 
     [bookmark: pgfId-7963137]License: Any
 
     [bookmark: pgfId-8232466]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7821218]You can configure the system policy so that Custom Analysis widgets are enabled on the dashboard. Dashboards provide you with at-a-glance views of current system status through the use of widgets: small, self-contained components that provide insight into different aspects of the FireSIGHT System. 
 
     [bookmark: pgfId-7821222]The Custom Analysis widget allows you to create a visual representation of events based on a flexible, user-configurable query of the events in your appliance's database. See Understanding the Custom Analysis Widget for more information on how to use custom widgets. 
 
     [bookmark: pgfId-7821226]To enable Custom Analysis widgets:
 
     [bookmark: pgfId-7821227]Access: Admin
 
     
 
     [bookmark: pgfId-8036291]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7821229]The System Policy page appears.
 
     [bookmark: pgfId-7821230]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7821231]To modify the dashboard settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) 
        next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7821232]To configure the dashboard settings as part of a new system policy, click  Create Policy . Provide a name and description for the system policy as described in Creating a System Policy, and click  Save. 
 
      
 
     
 
     [bookmark: pgfId-7821236]In either case, the Access List page appears.
 
     [bookmark: pgfId-7821237]Step 3 Click Dashboard.
 
     [bookmark: pgfId-7914417]The Dashboard Settings page appears.
 
     [bookmark: pgfId-7821242]Step 4 Select the Enable Custom Analysis Widgets check box to allow users to add Custom Analysis widgets to dashboards. Clear the check box to prohibit users from using those widgets.
 
     [bookmark: pgfId-8018584]Step 5 Click Save Policy and Exit.
 
     [bookmark: pgfId-8018585]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195711]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8018593][bookmark: 97207][bookmark: 49495]Configuring Databa[bookmark: marker-8018592]se Event Limits
 
     [bookmark: pgfId-7967946]License: Any
 
     [bookmark: pgfId-8232494]Supported Devices: Any except X-Series
 
      
       
        
        [bookmark: pgfId-8220559]Table 63-2 [bookmark: 57797]Database Event Limits 
 
        
        
         
         	 
           
           [bookmark: pgfId-8220565]Event Type 
          
  
         	 
           
           [bookmark: pgfId-8220567]Upper Event Limit 
          
  
         	 
           
           [bookmark: pgfId-8220569]Lower Event Limit 
          
  
        
 
         
         	[bookmark: pgfId-8220571]intrusion events
  
         	[bookmark: pgfId-8220573]2.5 million (DC500)
10 million (DC1000, virtual Defense Center)
20 million (DC750)
30 million (DC1500) 
60 million (DC2000)
100 million (DC3000)
150 million (DC3500)
300 million (DC4000)
  
         	[bookmark: pgfId-8220578]10,000
  
        
 
         
         	[bookmark: pgfId-8220580]discovery events
  
         	[bookmark: pgfId-8220582]10 million 
20 million (DC2000, DC4000)
  
         	[bookmark: pgfId-8220584]zero (disables storage)
  
        
 
         
         	[bookmark: pgfId-8220586]connection events
 [bookmark: pgfId-8220587]Security Intelligence Events
  
         	[bookmark: pgfId-8223244]10 million (DC500, DC1000, virtual Defense Center)
50 million (DC750)
100 million (DC1500, DC3000)
300 million (DC2000)
500 million (DC3500)
1 billion (DC4000)
 [bookmark: pgfId-8220593]Upper event limit is shared between connection events and Security Intelligence events; the sum of configured maximums for the two events cannot exceed the upper event limit.
  
         	[bookmark: pgfId-8220595]zero (disables storage)
  
        
 
         
         	[bookmark: pgfId-8220597]connection summaries (aggregated connection events)
  
         	[bookmark: pgfId-8220602]10 million (DC500, DC1000, virtual Defense Center)
50 million (DC750)
100 million (DC1500, DC3000)
300 million (DC2000)
500 million (DC3500)
1 billion (DC4000)
  
         	[bookmark: pgfId-8220604]zero (disables storage)
  
        
 
         
         	[bookmark: pgfId-8220606]correlation and compliance white list events
  
         	[bookmark: pgfId-8220608]1 million 
2 million (DC2000, DC4000)
  
         	[bookmark: pgfId-8220610]one
  
        
 
         
         	[bookmark: pgfId-8220612]malware events
  
         	[bookmark: pgfId-8220614]10 million 
20 million (DC2000, DC4000)
  
         	[bookmark: pgfId-8220616]10,000
  
        
 
         
         	[bookmark: pgfId-8220618]file events
  
         	[bookmark: pgfId-8220620]10 million
20 million (DC2000, DC4000)
  
         	[bookmark: pgfId-8220622]zero (disables storage)
  
        
 
         
         	[bookmark: pgfId-8220624]health events
  
         	[bookmark: pgfId-8220626]1 million 
  
         	[bookmark: pgfId-8220628]zero (disables storage)
  
        
 
         
         	[bookmark: pgfId-8220630]audit records
  
         	[bookmark: pgfId-8220632]100,000 
  
         	[bookmark: pgfId-8220634]one
  
        
 
         
         	[bookmark: pgfId-8220636]remediation status events
  
         	[bookmark: pgfId-8220638]10 million 
  
         	[bookmark: pgfId-8220640]one
  
        
 
         
         	[bookmark: pgfId-8220642]the white list violation history of the hosts on your network
  
         	[bookmark: pgfId-8220644]a 30-day history of violations
  
         	[bookmark: pgfId-8220646]one day’s history
  
        
 
         
         	[bookmark: pgfId-8220648]user activity (user events)
  
         	[bookmark: pgfId-8220650]10 million 
  
         	[bookmark: pgfId-8220652]one
  
        
 
         
         	[bookmark: pgfId-8220654]user logins (user history)
  
         	[bookmark: pgfId-8220656]10 million
  
         	[bookmark: pgfId-8220658]one
  
        
 
         
         	[bookmark: pgfId-8220660]rule update import log records
  
         	[bookmark: pgfId-8220662]1 million
  
         	[bookmark: pgfId-8220664]one
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8103365]If the number of events in the intrusion event database exceeds the maximum, the oldest events and packet files are pruned until the database is back within the event limits. See Configuring a Mail Relay Host and Notification Address for information about generating automated email notifications when events are automatically pruned.
 
     [bookmark: pgfId-7821531]For information on manually pruning the discovery and user databases, see Purging Discovery Data from the Database.
 
     [bookmark: pgfId-7994423]In addition, you can configure an email address that will receive notifications when intrusion events and audit records are pruned from the database.
 
     [bookmark: pgfId-7949467]To configure the maximum number of records in the database:
 
     [bookmark: pgfId-7821534]Access: Admin
 
     
 
     [bookmark: pgfId-8036326]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-8001990]The System Policy page appears.
 
     [bookmark: pgfId-8001993]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8001994]To modify the database settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7821541]To configure the database settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7821542]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7821546]In either case, the Access Control Preferences page appears.
 
     [bookmark: pgfId-7821547]Step 3 Click Database.
 
     [bookmark: pgfId-7821548]The Database page appears.
 
     [bookmark: pgfId-7996209]Step 4 For each of the databases, enter the number of records you want to store.
 
     [bookmark: pgfId-8057020]For information on how many records each database can maintain, see the Database Event Limits table.
 
     [bookmark: pgfId-7994455]Step 5 Optionally, in the Data Pruning Notification Address field, enter the email address you want to receive notifications when intrusion events, discovery events, audit records, security intelligence data, or URL filtering data are pruned from the appliance’s database.
 
     [bookmark: pgfId-8151605]Note that you must also configure an email server. See Configuring a Mail Relay Host and Notification Address for more information.
 
     [bookmark: pgfId-7949049]Step 6 Click Save Policy and Exit.
 
     [bookmark: pgfId-7893557]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195731]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7821732][bookmark: 80676]Configuring DNS [bookmark: marker-7821731]Cache Properties
 
     [bookmark: pgfId-7968000]License: Any
 
     [bookmark: pgfId-8232515]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7821735]If you have a DNS server configured on the Network page, you can configure the appliance to resolve IP addresses automatically on the event view pages. As a user assigned the Administrator role, you can also configure basic properties for DNS caching performed by the appliance. Configuring DNS caching allows you to identify IP addresses you previously resolved without performing additional lookups. This can reduce the amount of traffic on your network and speed the display of event pages when IP address resolution is enabled.
 
     [bookmark: pgfId-7821736]To configure the DNS cache properties:
 
     [bookmark: pgfId-7821737]Access: Admin
 
     
 
     [bookmark: pgfId-8036339]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7821739]The System Policy page appears.
 
     [bookmark: pgfId-7821740]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7821741]To modify the DNS cache settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7821742]To configure the DNS cache settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7821743]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7821747]In either case, the Access List page appears.
 
     [bookmark: pgfId-7821748]Step 3 Click DNS Cache.
 
     [bookmark: pgfId-7821749]The DNS Cache page appears.
 
     [bookmark: pgfId-7821754]Step 4 Select Enabled from the DNS Resolution Caching drop-down list to enable caching. Select Disabled to disable it.
 
      
       
     
 
     
 
     [bookmark: pgfId-7821755]Note DNS resolution caching is a system-wide setting that allows the caching of previously resolved DNS lookups. To configure IP address resolution on a per-user-account basis, users must also select Event View Settings from the User Preferences menu, enable Resolve IP Addresses, and then click Save. For information about configuring DNS servers, see Configuring Management Interfaces. For information about configuring event view preferences, see Configuring Event View Settings.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7821763]Step 5 In the DNS Cache Timeout (in minutes) field[bookmark: marker-7821762], enter the number of minutes a DNS entry remains cached in memory before it is removed for inactivity. 
 
     [bookmark: pgfId-7821764]The default setting is 300 minutes (five hours).
 
     [bookmark: pgfId-7821765]Step 6 Click Save Policy and Exit.
 
     [bookmark: pgfId-7821766]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7821770] 
      Caution Although DNS caching is enabled for the appliance, IP address resolution is not enabled on a per-user basis unless it is configured on the Events page accessed from the User Preferences menu. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8195747]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7821834][bookmark: 50482]Configuring a Mail Relay Host and[bookmark: marker-7821833] Notification Address
 
     [bookmark: pgfId-7968027]License: Any
 
     [bookmark: pgfId-8232536]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7821837]You must configure a mail host if you plan to:
 
      
      	 [bookmark: pgfId-7821838]email event-based reports
 
      	 [bookmark: pgfId-7821839]email status reports for scheduled tasks
 
      	 [bookmark: pgfId-8023323]email change reconciliation reports
 
      	 [bookmark: pgfId-7821843]email data pruning notifications
 
      	 [bookmark: pgfId-8149367]use email for discovery event, impact flag, and correlation event alerting
 
      	 [bookmark: pgfId-8149356]use email for intrusion event alerting
 
      	 [bookmark: pgfId-8149357]use email for health event alerting
 
     
 
     [bookmark: pgfId-8149358]You can select an encryption method for the communication between appliance and mail relay host, and can supply authentication credentials for the mail server if needed. After configuring settings, you can test the connection between the appliance and the mail server using the supplied settings.
 
     [bookmark: pgfId-7949458]To configure a mail relay host:
 
     [bookmark: pgfId-7821863]Access: Admin
 
     
 
     [bookmark: pgfId-8036357]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7821865]The System Policy page appears.
 
     [bookmark: pgfId-7821866]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7821867]To modify the email settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7821868]To configure the email settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7821869]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7821873]In either case, the Access List page appears.
 
     [bookmark: pgfId-7821874]Step 3 Click Email Notification.
 
     [bookmark: pgfId-7821875]The Configure Email Notification page appears.
 
     [bookmark: pgfId-7948272]Step 4 In the Mail Relay Host field, type the hostname or IP address of the mail server you want to use. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7821881]Note The mail host you enter must allow access from the appliance.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7994508]Step 5 Enter the port number to use on the email server in the Port Number field. Typical ports include 25, when using no encryption, 465, when using SSLv3, and 587, when using TLS. 
 
     [bookmark: pgfId-7994509]Step 6 To select an encryption method, you have the following options:
 
      
       
       	 [bookmark: pgfId-7994510]To encrypt communications between the appliance and the mail server using Transport Layer Security, select  TLS from the  Encryption Method drop-down list.
 
       	 [bookmark: pgfId-7994511]To encrypt communications between the appliance and the mail server using Secure Socket Layers, select  SSLv3 from the  Encryption Method drop-down list.
 
       	 [bookmark: pgfId-8057402]To allow unencrypted communication between the appliance and the mail server, select  None  from the  Encryption Method drop-down list.
 
      
 
     
 
     [bookmark: pgfId-8057425]Note that certificate validation is not required for encrypted communication between the appliance and mail server. 
 
     [bookmark: pgfId-7994514]Step 7 Enter a valid email address in the From Address field for use as the source email address for messages sent by the appliance. 
 
     [bookmark: pgfId-7994515]Step 8 Optionally, to supply a user name and password when connecting to the mail server, select Use Authentication. Enter a user name in the Username field. Enter a password in the Password field.
 
     [bookmark: pgfId-7994516]Step 9 To send a test email using the configured mail server, click Test Mail Server Settings. 
 
     [bookmark: pgfId-7994517]A message appears next to the button indicating the success or failure of the test.
 
     [bookmark: pgfId-7949495]Step 10 Click Save Policy and Exit.
 
     [bookmark: pgfId-8219610]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8219614]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8220061][bookmark: 23454]Configuring Network Analysis Policy[bookmark: marker-8220060] Preferences
 
     [bookmark: pgfId-8220069]License: Protection
 
     [bookmark: pgfId-8232557]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8220070]You can configure the system to prompt users for a comment when they modify a network analysis policy. You can use this to track users’ reasons for policy changes. If you enable comments on network analysis policy changes, you can make the comments optional or mandatory. The change description is written to the audit log.
 
     [bookmark: pgfId-8220071]You can also have all network analysis policy changes written to the audit log. For more information on the audit log, see Managing Audit Records.
 
     [bookmark: pgfId-8220075]To configure the network analysis policy comment settings:
 
     [bookmark: pgfId-8220079]Access: Admin
 
     
 
     [bookmark: pgfId-8220080]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-8220081]The System Policy page appears.
 
     [bookmark: pgfId-8220082]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8220086]To modify the network analysis policy preferences in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-8220087]To configure the network analysis policy preferences as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-8220090]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-8220092]In either case, the Access List page appears.
 
     [bookmark: pgfId-8220093]Step 3 Click Network Analysis Policy Preferences.
 
     [bookmark: pgfId-8220094]The Network Analysis Policy Preferences page appears.
 
     [bookmark: pgfId-8220095]Step 4 From the Comments on policy change drop-down list, you have the following options:
 
      
       
       	 [bookmark: pgfId-8220096]Select  Disabled to allow users to modify a network analysis policy without entering a change description.
 
       	 [bookmark: pgfId-8220097]Select  Optional to display the Description of Changes window to users when they save changes to a network analysis policy. This allows users the option to describe changes in a comment.
 
       	 [bookmark: pgfId-8220098]Select  Required to display the Description of Changes window to users when they save changes to a network analysis policy. This requires users to describe changes in a comment before the changes are saved.
 
      
 
     
 
     [bookmark: pgfId-8220099]Step 5 Optionally, if you want to write all network analysis policy changes to the audit log, select Write changes in Network Analysis Policy to audit log.
 
     [bookmark: pgfId-8220100]Step 6 Click Save Policy and Exit.
 
     [bookmark: pgfId-8220101]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8220105]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8219618][bookmark: 14124]Configuring Intrusion Policy[bookmark: marker-8219617] Preferences
 
     [bookmark: pgfId-8048781]License: Protection
 
     [bookmark: pgfId-8232629]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8067835]You can configure the system to prompt users for a comment when they modify an intrusion policy. You can use this to track users’ reasons for policy changes. If you enable comments on intrusion policy changes, you can make the comments optional or mandatory. The change description is written to the audit log.
 
     [bookmark: pgfId-8066884]You can also have all intrusion policy changes written to the audit log. For more information on the audit log, see Managing Audit Records.
 
     [bookmark: pgfId-7841927]To configure the intrusion policy comment settings:
 
     [bookmark: pgfId-7841928]Access: Admin
 
     
 
     [bookmark: pgfId-8036370]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7841930]The System Policy page appears.
 
     [bookmark: pgfId-7841931]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7841932]To modify the intrusion policy preferences in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7841933]To configure the intrusion policy preferences as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7841934]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7841938]In either case, the Access List page appears.
 
     [bookmark: pgfId-7841939]Step 3 Click Intrusion Policy Preferences.
 
     [bookmark: pgfId-7841940]The Intrusion Policy Preferences page appears.
 
     [bookmark: pgfId-7841945]Step 4 From the Comments on policy change drop-down list, you have the following options:
 
      
       
       	 [bookmark: pgfId-8061832]Select  Disabled to allow users to modify an intrusion policy without entering a change description.
 
       	 [bookmark: pgfId-8061833]Select  Optional to display the Description of Changes window to users when they save changes to an intrusion policy. This allows users the option to describe changes in a comment.
 
       	 [bookmark: pgfId-8061828]Select  Required to display the Description of Changes window to users when they save changes to an intrusion policy. This requires users to describe changes in a comment before the changes are saved.
 
      
 
     
 
     [bookmark: pgfId-7842195]Step 5 Optionally, if you want to write all intrusion policy changes to the audit log, select Write changes in Intrusion Policy to audit log.
 
     [bookmark: pgfId-7841946]Step 6 Click Save Policy and Exit.
 
     [bookmark: pgfId-7841947]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195815]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7837314][bookmark: 45189]Specifying a Diffe[bookmark: marker-7821949]rent Language
 
     [bookmark: pgfId-7968051]License: Any
 
     [bookmark: pgfId-8232663]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7821954]You can use the Language page to specify a different language for the web interface.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7821955] 
      Caution The language you select here is used for the web interface for every user who logs into the appliance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7821956]To select a different language for the user interface:
 
     [bookmark: pgfId-7821957]Access: Admin
 
     
 
     [bookmark: pgfId-8036384]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7821959]The System Policy page appears.
 
     [bookmark: pgfId-7821960]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7821961]To modify the language settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7821962]To configure the language settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7821963]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7821967]In either case, the Access List page appears.
 
     [bookmark: pgfId-7821968]Step 3 Click Language.
 
     [bookmark: pgfId-7821969]The Language page appears.
 
     [bookmark: pgfId-7821974]Step 4 Select the language you want to use.
 
     [bookmark: pgfId-7821975]Step 5 Click Save Policy and Exit.
 
     [bookmark: pgfId-7821976]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195834]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7822043][bookmark: 20725]Adding a[bookmark: marker-7822041] Custom Login Banner
 
     [bookmark: pgfId-7968078]License: Any
 
     [bookmark: pgfId-8232690]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7822046]You can create a custom login banner that appears when users log into the appliance using SSH and on the login page of the web interface. Banners can contain any printable characters except the less-than symbol (<) and the greater-than symbol (>).
 
     [bookmark: pgfId-7822048]To add a custom banner:
 
     [bookmark: pgfId-7822049]Access: Admin
 
     
 
     [bookmark: pgfId-8036400]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7822051]The System Policy page appears.
 
     [bookmark: pgfId-7822052]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7822053]To modify the login banner in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7822054]To configure the login banner as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7822055]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7822059]In either case, the Access List page appears.
 
     [bookmark: pgfId-7822060]Step 3 Click Login Banner.
 
     [bookmark: pgfId-7822061]The Login Banner page appears.
 
     [bookmark: pgfId-7822066]Step 4 In the Custom Login Banner field, enter the login banner you want to use with this system policy.
 
     [bookmark: pgfId-7822067]Step 5 Click Save Policy and Exit.
 
     [bookmark: pgfId-7822068]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195856]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7994800][bookmark: 29722]Config[bookmark: marker-7996113]uring SNMP Polling
 
     [bookmark: pgfId-8048808]License: Any
 
     [bookmark: pgfId-8232711]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8048810]You can enable Simple Network Management Protocol (SNMP) polling of an appliance using the system policy. The SNMP feature supports use of versions 1, 2, and 3 of the SNMP protocol.
 
     [bookmark: pgfId-7994813]This feature allows access to:
 
      
      	 [bookmark: pgfId-8048525]the standard management information base (MIB) for the appliance, which includes system details such as contact, administrative, location, service information, IP addressing and routing information, and transmission protocol usage statistics
 
      	 [bookmark: pgfId-8048536]additional MIBs for managed devices that include statistics on traffic passing through physical interfaces, logical interfaces, virtual interfaces, ARP, NDP, virtual bridges, and virtual routers
 
     
 
     [bookmark: pgfId-8048413]Note that enabling the system policy SNMP feature does not cause the appliance to send SNMP traps; it only makes the information in the MIBs available for polling by your network management system.
 
      
       
     
 
     
 
     [bookmark: pgfId-7994814]Note Y[bookmark: marker-8071663]ou must add SNMP access for any computer you plan to use to poll the appliance. For more information, see Configuring the Access List for Your Appliance. Note that the SNMP MIB contains information that could be used to attack your appliance. Cisco recommends that you restrict your access list for SNMP access to the specific hosts that will be used to poll for the MIB. Cisco also recommends you use SNMPv3 and use strong passwords for network management access.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7994818]To configure SNMP polling:
 
     [bookmark: pgfId-7994819]Access: Admin
 
     
 
     [bookmark: pgfId-8036460]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7994821]The System Policy page appears.
 
     [bookmark: pgfId-7994822]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7994823]To modify the SNMP polling settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7994824]To configure the SNMP polling settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7994827]Provide a name and description for the system policy as described in Creating a System Policy, and click Create.
 
     [bookmark: pgfId-7994829]In either case, the Access List page appears.
 
     [bookmark: pgfId-7994830]Step 3 If you have not already added SNMP access for each computer you plan to use to poll the appliance, do so now. For more information, see Configuring the Access List for Your Appliance.
 
     [bookmark: pgfId-7994834]Step 4 Click SNMP.
 
     [bookmark: pgfId-7994835]The SNMP page appears.
 
     [bookmark: pgfId-8048036]Step 5 From the SNMP Version drop-down list, select the SNMP version you want to use.
 
     [bookmark: pgfId-8048059]The drop-down list displays the version you selected.
 
     [bookmark: pgfId-8048082]Step 6 [bookmark: 75965]You have the following options:
 
      
       
       	 [bookmark: pgfId-8048083]If you selected  Version 1 or  Version 2 , type the SNMP community name in the  Community String field. Go to step  15 .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8240305]Note SNMPv2 only supports read-only communities.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-8062681]If you selected  Version 3 , click  Add User to display the user definition page.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8240358]Note SNMPv3 only supports read-only users. SNMPv3 also supports encryption with AES128.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8048198]Step 7 Enter a username in the Username field.
 
     [bookmark: pgfId-8062754]Step 8 Select the protocol you want to use for authentication from the Authentication Protocol drop-down list.
 
     [bookmark: pgfId-8048367]Step 9 Type the password required for authentication with the SNMP server in the Authentication Password field. 
 
     [bookmark: pgfId-8062975]Step 10 Retype the authentication password in the Verify Password field just below the Authentication Password field.
 
     [bookmark: pgfId-8048368]Step 11 Select the privacy protocol you want to use from the Privacy Protocol list, or select None to not use a privacy protocol.
 
     [bookmark: pgfId-8063190]Step 12 Type the SNMP privacy key required by the SNMP server in the Privacy Password field.
 
     [bookmark: pgfId-8063204]Step 13 [bookmark: 29082]Retype the privacy password in the Verify Password field just below the Privacy Password field.
 
     [bookmark: pgfId-8063192]Step 14 [bookmark: 88438]Click Add.
 ) to delete a user. 
     
 
     [bookmark: pgfId-7994860]Step 15 [bookmark: 69031]Click Save Policy and Exit.
 
     [bookmark: pgfId-7994861]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195872]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8145056][bookmark: 67083]Enabling STIG Compli[bookmark: marker-8153881]ance
 
     [bookmark: pgfId-8145104]License: Any
 
     [bookmark: pgfId-8232751]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8145131]O[bookmark: marker-8152221]rganizations within the United States federal government sometimes need to comply with a series of security checklists set out in Security Technical Implementation Guides (STIGs). The STIG Compliance option enables settings intended to support compliance with specific requirements set out by the United States Department of Defense. 
 
     [bookmark: pgfId-8150083]If you enable STIG compliance on any appliances in your deployment, you must enable it on all appliances. Non-compliant managed devices cannot be registered to STIG-compliant Defense Centers and STIG-compliant devices cannot be registered to non-compliant Defense Centers. 
 
     [bookmark: pgfId-8146067]Enabling STIG compliance does not guarantee strict compliance to all applicable STIGs. For more information on FireSIGHT System STIG compliance when using this mode for this version of the product, contact Support to obtain a copy of the FireSIGHT System STIG Release Notes for Version 5.4.1. 
 
     [bookmark: pgfId-8146534]When you enable STIG compliance, password complexity and retention rules for local shell access accounts change. For more information on these settings, see the FireSIGHT System STIG Release Notes for Version 5.4.1. In addition, you cannot use ssh remote storage when in STIG compliance mode. 
 
     [bookmark: pgfId-8150419]Note that applying a system policy with STIG compliance enabled forces appliances to reboot. If you apply a system policy with STIG enabled to an appliance that already has STIG enabled, the appliance does not reboot. If you apply a system policy with STIG disabled to an appliance that has STIG enabled, STIG remains enabled and the appliance does not reboot.
 
     [bookmark: pgfId-8153597]For appliances upgraded from versions earlier than Version 5.2.0, applying a policy with compliance enabled also regenerates appliance certificates, so you will need to re-register already registered managed devices or peers. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8146308] 
      Caution You cannot disable this setting without assistance from Support. In addition, this setting may substantially impact the performance of your system. Cisco does not recommend enabling STIG compliance except to comply with Department of Defense security requirements. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8146358]To enable STIG compliance:
 
     [bookmark: pgfId-8146359]Access: Admin
 
     
 
     [bookmark: pgfId-8146360]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-8146361]The System Policy page appears.
 
     [bookmark: pgfId-8146362]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8146363]To modify the time settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-8146367]To configure the time settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-8146368]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-8146372]In either case, the Access List page appears.
 
     [bookmark: pgfId-8146373]Step 3 Click STIG Compliance.
 
     [bookmark: pgfId-8146374]The STIG Compliance page appears.
 
     [bookmark: pgfId-8146382]Step 4 If you want to permanently enable STIG compliance on the appliance, select Enable STIG Compliance.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8147322] 
      Caution You cannot disable STIG compliance on an appliance after you apply a policy with STIG compliance enabled. If you need to disable compliance, contact Support. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8150699]Step 5 Click Save Policy and Exit.
 
     [bookmark: pgfId-8150700]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8150740]When you apply a system policy that enables STIG compliance to an appliance, note that the appliance reboots. Note that if you apply a system policy with STIG enabled to an appliance that already has STIG enabled, the appliance does not reboot. 
 
     [bookmark: pgfId-8153730]In addition, you need to re-register devices after enabling STIG compliance if the devices were upgraded from versions earlier than Version 5.2.0. 
 
     [bookmark: pgfId-8195887]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8146312][bookmark: 78649]Synchron[bookmark: marker-8146310]izing Time
 
     [bookmark: pgfId-7968109]License: Any
 
     [bookmark: pgfId-8232772]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7823132]You can manage time synchronization on the appliance using the Time Synchronization page. You can choose to synchronize the time:
 
      
      	 [bookmark: pgfId-7823133]manually
 
      	 [bookmark: pgfId-7823137]using one or more NTP servers (one of which can be a Defense Center)
 
     
 
     [bookmark: pgfId-7823138]Time settings are part of the system policy. You can specify the time settings either by creating a new system policy or by editing an existing policy. In either case, the time setting is not used until you apply the system policy.
 
     [bookmark: pgfId-7823139]Note that time settings are displayed on most pages on the appliance in local time using the time zone you set on the Time Zone page (America/New York by default), but are stored on the appliance itself using UTC time. In addition, the current time appears in UTC at the top of the Time Synchronization page (local time is displayed in the Manual clock setting option, if enabled).
 
     [bookmark: pgfId-8149459]You mu[bookmark: marker-8153413]st use native applications, such as command line interfaces or the operating system interface, to manage time settings for Cisco NGIPS for Blue Coat X-Series. Synchronize time for Cisco NGIPS for Blue Coat X-Series and its managing Defense Center from the same physical appliance or NTP server. For more information, see the Cisco Software for X-Series Installation Guide. 
 
     [bookmark: pgfId-7921389]You can synchronize the appliance’s time with an external time server. If you specify a remote NTP server, your appliance must have network access to it. Do not specify an untrusted NTP server. Connections to NTP servers do not use configured proxy settings. To use the Defense Center as an NTP server, see Serving Time from the Defense Center.
 
     [bookmark: pgfId-7921396]Cisco recommends that you synchronize your virtual appliances to a physical NTP server. Do not synchronize your managed devices (virtual or physical) to a Virtual Defense Center.
 
      
       
     
 
     
 
     [bookmark: pgfId-8148527]Note Ensure that the time on your Defense Center and managed devices matches after time synchronization. Otherwise, unintended consequences may occur when the managed devices communicate with the Defense Center.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7921397]The procedure for synchronizing time differs slightly depending on whether you are using the web interface on a Defense Center or a managed device. Each procedure is explained separately below.
 
     [bookmark: pgfId-7823182]To synchronize time:
 
     [bookmark: pgfId-7823183]Access: Admin
 
     
 
     [bookmark: pgfId-8036485]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-8042808]The System Policy page appears.
 
     [bookmark: pgfId-8042809]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8042810]To modify the time settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7823188]To configure the time settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7823189]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7823193]In either case, the Access List page appears.
 
     [bookmark: pgfId-7823194]Step 3 Click Time Synchronization.
 
     [bookmark: pgfId-7823195]The Time Synchronization page appears.
 
     [bookmark: pgfId-7823203]Step 4 If you want to serve time from the Defense Center to your managed devices, in the Serve time via NTP drop-down list, select Enabled.
 
     [bookmark: pgfId-7823211]Step 5 You have the following options for specifying how the time is synchronized on the Defense Center:
 
      
       
       	 [bookmark: pgfId-8019730]To set the time manually, select  Manually in Local Configuration . See Setting the Time Manually for information about setting the time after you apply the system policy.
 
       	 [bookmark: pgfId-7823216]To receive time through NTP from a different server, select  Via NTP from and, in the text box, type a comma-separated list of IP addresses for the NTP servers you want to use or, if DNS is enabled, type the fully qualified host and domain names.
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7823217] 
      Caution If the appliance is rebooted and your DHCP server sets an NTP server record different than the one you specify here, the DHCP-provided NTP server will be used instead. To avoid this situation, configure your DHCP server to set the same NTP server. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8063779]Step 6 You have the following options for specifying how time is synchronized on any managed devices:
 
      
       
       	 [bookmark: pgfId-8063782]Select  Manually in Local Configuration  to set the time manually. See Setting the Time Manually for information about setting the time after you apply the system policy.
 
       	 [bookmark: pgfId-8063826]Select  Via NTP from   Defense Center to receive time through NTP from the Defense Center. See Serving Time from the Defense Center for more information.
 
       	 [bookmark: pgfId-8063784]Select  Via NTP from to receive time through NTP from different servers. In the text box, type a comma-separated list of IP addresses of the NTP servers or, if DNS is enabled, type the fully qualified host and domain names.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8064086]Note It may take a few minutes for the managed device to synchronize with the configured NTP servers. In addition, if you are synchronizing the managed device to a Defense Center that is configured as an NTP server, and the Defense Center itself is configured to use an NTP server, it may take some time for the time to synchronize. This is because the Defense Center must first synchronize with its configured NTP server before it can serve time to the managed device.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8063774]Step 7 Click Save Policy and Exit.
 
     [bookmark: pgfId-7823219]The system policy is updated. Your changes do not take effect until you apply the system policy. See Applying a System Policy for more information.
 
     [bookmark: pgfId-8195907]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8063642][bookmark: 33273]Serving Time fro[bookmark: marker-8063637]m th[bookmark: marker-8063638]e Defense Center
 
     [bookmark: pgfId-7963423]License: Any
 
     [bookmark: pgfId-8232798]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7823351]You can configure the Defense Center as a time server using NTP and then use it to synchronize time between the Defense Center and managed devices. 
 
     [bookmark: pgfId-7823361]Note that you cannot set the time manually after configuring the Defense Center to serve time using NTP. If you need to manually change the time, you should do so before configuring the Defense Center to serve time using NTP. If you need to change the time manually after configuring the Defense Center as an NTP server, disable the Via NTP option and click Save, change the time manually and click Save, and then enable Via NTP and click Save.
 
      
       
     
 
     
 
     [bookmark: pgfId-7823371]Note If you configure the Defense Center to serve time using NTP, and then later disable it, the NTP service on managed devices still attempts to synchronize time with the Defense Center. You must disable NTP from the managed devices’ web interfaces to stop the synchronization attempts.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7823378]To configure the Defense Center as an NTP server:
 
     [bookmark: pgfId-7823379]Access: Admin
 
     
 
     [bookmark: pgfId-8036512]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7823384]The System Policy page appears.
 
     [bookmark: pgfId-7823385]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7823386]To modify the NTP server settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7823387]To configure the NTP server settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7823388]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7823392]In either case, the Access List page appears.
 
     [bookmark: pgfId-7823393]Step 3 Click Time Synchronization.
 
     [bookmark: pgfId-7823394]The Time Synchronization page appears.
 
     [bookmark: pgfId-7823395]Step 4 From the Serve Time via NTP drop-down list, select Enabled.
 
     [bookmark: pgfId-7823396]Step 5 In the Set My Clock option for the managed device, select Via NTP from Defense Center.
 
     [bookmark: pgfId-7823397]Step 6 Click Save Policy and Exit.
 
     [bookmark: pgfId-7823398]The system policy is updated. Your changes do not take effect until you apply the system policy to the Defense Center and its managed devices. See Applying a System Policy for more information. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7823408]Note It may take a few minutes for the Defense Center to synchronize with its managed devices.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8195931]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8120639][bookmark: 30185]Configuring User Interf[bookmark: marker-8138374]ace Settings
 
     [bookmark: pgfId-8120684]License: Any
 
     [bookmark: pgfId-8232827]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-8120696]Unattended login sessions of the FireSIGHT System web interface or command line interface may be security risks. You can configure, in minutes, the amount of idle time before a user’s login session times out due to inactivity. You can also set a similar timeout for shell (command line) sessions. 
 
     [bookmark: pgfId-8125562]Your deployment may have users who plan to passively, securely monitor the web interface for long periods of time. You can exempt users from the web interface session timeout with a user configuration option. (Users with the Administrator role, whose complete access to menu options poses an extra risk if compromised, cannot be made exempt from session timeouts.) For more information, see Managing User Login Settings.
 
     [bookmark: pgfId-8125563]For cases in which you must restrict shell access to the system, a third option allows you to permanently disable the expert command in the command line. Disabling expert mode on an appliance prevents any user, even users with Configuration shell access, from going into expert mode in the shell. When a user goes into expert mode on the command line, the user can run any Linux command appropriate to the shell. When not in expert mode, command line users can only run the commands provided by the command line interface. Note that the command line interface is not supported for Series 2 appliances.
 
     [bookmark: pgfId-8122973]For more information on command line interface commands, see Command Line Reference. For information on setting up users for command line access, see Managing Command Line Access and Command Line Reference (for virtual device CLI user management). 
 
     [bookmark: pgfId-8121235]To configure user interface settings:
 
     [bookmark: pgfId-8121480]Access: Admin
 
     
 
     [bookmark: pgfId-8121495]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-8121546]The System Policy page appears.
 
     [bookmark: pgfId-8121592]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8121640]To modify user interface settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-8121644]To configure user interface settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-8121645]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-8121709]In either case, the Access List page appears.
 
     [bookmark: pgfId-8121700]Step 3 Click User Interface.
 
     [bookmark: pgfId-8121856]The User Interface page appears.
 
     [bookmark: pgfId-8121858]Step 4 You have the following options:
 
      
       
       	 [bookmark: pgfId-8121927]To configure session timeout for the web interface, type a number (of minutes) in the  Browser Session Timeout (Minutes)  field. The default value is  60 ; the maximum value is  1440 (24 hours).
 
      
 
     
 
     [bookmark: pgfId-8123978]For information on how to exempt users from this session timeout, see Managing User Login Settings.
 
      
       
       	 [bookmark: pgfId-8122090]To configure session timeout for the command line interface, type a number (of minutes) in the  Shell Timeout (Minutes) field. The default value is  0 ; the maximum value is  1440 (24 hours).
 
       	 [bookmark: pgfId-8122245]To permanently disable the  expert command in the command line interface, select the  Permanently Disable Expert Access check box.
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8123013] 
      Caution After you apply a system policy with expert mode disabled to an appliance, you cannot restore the ability to access expert mode through the web interface or the command line. You must contact Support to restore the expert mode capability. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8122689]Step 5 Click Save Policy and Exit.
 
     [bookmark: pgfId-8122722]The system policy is updated. Your changes do not take effect until you apply the system policy to the Defense Center and its managed devices. Changes to session timeout intervals do not take effect until the next login session.
 
     [bookmark: pgfId-8195955]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7823419][bookmark: 72195]Mapping Vulne[bookmark: marker-7891309]rabilities for Servers
 
     [bookmark: pgfId-7963434]License: Protection
 
     [bookmark: pgfId-8232848]Supported Devices: Any except X-Series
 
     [bookmark: pgfId-7823430]The FireSIGHT System automatically maps vulnerabilities to a host IP address for any application protocol traffic received or sent from that address, when the server has an application ID in the discovery event database and the packet header for the traffic includes a vendor and version. 
 
     [bookmark: pgfId-7823431]However, many servers do not include vendor and version information. For the server listed in the system policy, you can configure whether the system associates vulnerabilities with server traffic for vendor and versionless servers. 
 
     [bookmark: pgfId-7823435]For example, a host serves SMTP traffic that does not have a vendor or version in the header. If you enable the SMTP server on the Vulnerability Mapping page of a system policy, then apply that policy to the Defense Center managing the device that detects the traffic, all vulnerabilities associated with SMTP servers are added to the host profile for the host.
 
     [bookmark: pgfId-7911130]Although detectors collect server information and add it to host profiles, the application protocol detectors will not be used for vulnerability mapping, because you cannot specify a vendor or version for a custom application protocol detector and cannot select the server for vulnerability mapping in the system policy.
 
     [bookmark: pgfId-7823439]To configure vulnerability mapping for servers:
 
     [bookmark: pgfId-7823440]Access: Admin
 
     
 
     [bookmark: pgfId-8036530]Step 1 Select System > Local > System Policy.
 
     [bookmark: pgfId-7823442]The System Policy page appears.
 
     [bookmark: pgfId-7823443]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-7823444]To modify vulnerability mapping settings in an existing system policy, click the edit icon (
 
      
 
      [image: ] ) next to the system policy. 
     
 
      
       
       	 [bookmark: pgfId-7823445]To configure vulnerability mapping settings as part of a new system policy, click  Create Policy .
 
      
 
     
 
     [bookmark: pgfId-7823446]Provide a name and description for the system policy as described in Creating a System Policy, and click Save.
 
     [bookmark: pgfId-7823450]In either case, the Access List page appears.
 
     [bookmark: pgfId-7823451]Step 3 Click Vulnerability Mapping.
 
     [bookmark: pgfId-7823452]The Vulnerability Mapping page appears.
 
     [bookmark: pgfId-7823458]Step 4 You have the following options:
 
      
       
       	 [bookmark: pgfId-7823459]To prevent vulnerabilities for a server from being mapped to hosts that receive application protocol traffic without vendor or version information, clear the check box for that server.
 
       	 [bookmark: pgfId-7823460]To cause vulnerabilities for a server to be mapped to hosts that receive application protocol traffic without vendor or version information, select the check box for that server.
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7859466]Tip You can select or clear all check boxes at once using the check box next to Enabled.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7823461]Step 5 Click Save Policy and Exit.
 
     [bookmark: pgfId-7823462]The system policy is updated. Your changes do not take effect until you apply the system policy to the Defense Center and its managed devices. See Applying a System Policy for more information. 
 
     [bookmark: pgfId-8195971]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7823529]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-8343942][bookmark: 75906]Configuring Appliance [bookmark: marker-8343940][bookmark: marker-8343941]Settings 
      
      
 
     
 
 
    [bookmark: pgfId-8432786]A FireSIGHT System appliance’s local configuration (System > Local > Configuration) is a group of settings that is likely to be specific to a single appliance. Contrast the local configuration with the system policy (Managing System Policies), which controls appliance settings that are likely to be similar across a deployment.
 
    [bookmark: pgfId-7885811]The following table summarizes an appliance’s local configuration.
 
    [bookmark: pgfId-7885950]
 
     
      
       
       [bookmark: pgfId-8431984]Table 64-1 [bookmark: 51785]Local Configuration Options 
 
       
       
        
        	 
          
          [bookmark: pgfId-8431990]Option 
         
  
        	 
          
          [bookmark: pgfId-8431992]Description 
         
  
        	 
          
          [bookmark: pgfId-8431994]For more information, see... 
         
  
       
 
        
        	[bookmark: pgfId-8431996]Information
  
        	[bookmark: pgfId-8431998]Allows you to view current information about the appliance. You can also change the appliance name. 
  
        	[bookmark: pgfId-8432002]Viewing and Modifying the Appliance Information
  
       
 
        
        	[bookmark: pgfId-8432005]HTTPS Certificate
  
        	[bookmark: pgfId-8432007]Allows you to request an HTTPS server certificate, if needed, from a trusted authority and upload certificates to your appliance. 
  
        	[bookmark: pgfId-8432011]Using Custom HTTPS Certificates
  
       
 
        
        	[bookmark: pgfId-8432014]Database
  
        	[bookmark: pgfId-8432016]Lets you enable external read-only access to the appliance database, and provides a client driver for you to download.
  
        	[bookmark: pgfId-8432020]Enabling Access to the Database
  
       
 
        
        	[bookmark: pgfId-8569842]Management Interfaces
  
        	[bookmark: pgfId-8569844]Enables you to change options such as the IP address, hostname, and proxy settings of the appliance that were initially set up as part of the installation. You can also view and modify the settings for the management interfaces on your appliance.
  
        	[bookmark: pgfId-8569846]Configuring Management Interfaces
  
       
 
        
        	[bookmark: pgfId-8432041]Process
  
        	[bookmark: pgfId-8432043]Allows you to shut down or reboot the appliance, and restart FireSIGHT System-related processes.
  
        	[bookmark: pgfId-8432050]Shutting Down and Restarting the System
  
       
 
        
        	[bookmark: pgfId-8432072]Time
  
        	[bookmark: pgfId-8432074]Displays the current time. If the time synchronization settings in the current system policy for the appliance is set to Manually in Local Configuration, then you can use this page to change the time.
  
        	[bookmark: pgfId-8432078]Setting the Time Manually
  
       
 
        
        	[bookmark: pgfId-8432081]Remote Storage Device
  
        	[bookmark: pgfId-8432086]On Defense Centers, allows you to configure remote storage for backups and reports.
  
        	[bookmark: pgfId-8432090]Managing Remote Storage
  
       
 
        
        	[bookmark: pgfId-8432093]Change Reconciliation
  
        	[bookmark: pgfId-8432095]Allows you to receive, via email, a detailed report of changes to your system over the last 24 hours.
  
        	[bookmark: pgfId-8432099]Understanding Change Reconciliation
  
       
 
        
        	[bookmark: pgfId-8432102]Console Configuration
  
        	[bookmark: pgfId-8432104]Allows you configure console access to FireSIGHT System appliances via VGA or serial port, or via Lights-Out Management (LOM), which allows you to perform limited monitoring and management tasks without being physically near the appliance.
  
        	[bookmark: pgfId-8432111]Managing Remote Console Access
  
       
 
        
        	[bookmark: pgfId-8432114]Cloud Services
  
        	[bookmark: pgfId-8432116]On Defense Centers, allows you to download URL filtering data from the Collective Security Intelligence Cloud, perform lookups for uncategorized URLs, and send diagnostic information on detected files to Cisco.
  
        	[bookmark: pgfId-8432120]Enabling Cloud Communications
  
       
 
        
        	[bookmark: pgfId-8557954]VMware Tools
  
        	[bookmark: pgfId-8557956]On a virtual Defense Center, allows you to enable and use VMware Tools.
  
        	[bookmark: pgfId-8557958]Enabling VMware Tools
  
       
 
       
     
 
    
 
   
 
    
     [bookmark: pgfId-8432585][bookmark: 69128]Viewing and Modifying the[bookmark: marker-8432584] Appliance Information
 
    [bookmark: pgfId-8533662]License: Any
 
    [bookmark: pgfId-8533663]The Information page provides you with information about your appliances. The information includes read-only information, such as the product name and model number, the operating system and version, and the current appliance-level policies. The page also provides you with an option to change the name of the appliance.
 
    [bookmark: pgfId-6413442]The following table describes each field.
 
    [bookmark: pgfId-6413515]
 
     
      
       
       [bookmark: pgfId-8648700]Table 64-2 [bookmark: 64505]Appliance Information 
 
       
       
        
        	 
          
          [bookmark: pgfId-8648704]Field 
         
  
        	 
          
          [bookmark: pgfId-8648706]Description 
         
  
       
 
        
        	[bookmark: pgfId-8648708]Name
  
        	[bookmark: pgfId-8648710]A name you assign to the appliance. Note that this name is only used within the context of the FireSIGHT System. Although you can use the hostname as the name of the appliance, entering a different name in this field does not change the hostname.
  
       
 
        
        	[bookmark: pgfId-8648715]Product Model
  
        	[bookmark: pgfId-8648717]The model name for the appliance.
  
       
 
        
        	[bookmark: pgfId-8648719]Software Version
  
        	[bookmark: pgfId-8648721]The version of the software currently installed.
  
       
 
        
        	[bookmark: pgfId-8648723]Serial Number
  
        	[bookmark: pgfId-8648725]The chassis serial number of the appliance.
  
       
 
        
        	[bookmark: pgfId-8648727]Store Events Only on Defense Center
  
        	[bookmark: pgfId-8648732]Select this check box on the managed device to store event data on the Defense Center, but not the managed device. Clear this check box to store event data on both appliances.
  
       
 
        
        	[bookmark: pgfId-8648737]Prohibit Packet Transfer to the Defense Center
  
        	[bookmark: pgfId-8648742]Select this check box on the managed device to prevent the managed device from sending packet data with the events. Clear this check box to allow packet data to be stored on the Defense Center with events.
  
       
 
        
        	[bookmark: pgfId-8648747]Operating System
  
        	[bookmark: pgfId-8648749]The operating system currently running on the appliance.
  
       
 
        
        	[bookmark: pgfId-8648751]Operating System Version
  
        	[bookmark: pgfId-8648753]The version of the operating system currently running on the appliance.
  
       
 
        
        	[bookmark: pgfId-8648763]IPv4 Address
  
        	[bookmark: pgfId-8648765]The IPv4 address of the default (eth0) management interface of the appliance. If IPv4 management is disabled for the appliance, this field indicates that.
  
       
 
        
        	[bookmark: pgfId-8648767]IPv6 Address
  
        	[bookmark: pgfId-8648769]The IPv6 address of the default (eth0) management interface of the appliance. If IPv6 management is disabled for the appliance, this field indicates that.
  
       
 
        
        	[bookmark: pgfId-8648771]Current Policies
  
        	[bookmark: pgfId-8648773]The appliance-level policies currently applied. If a policy has been updated since it was last applied, the name of the policy appears in italics.
  
       
 
        
        	[bookmark: pgfId-8648775]Model Number
  
        	[bookmark: pgfId-8648777]The model number for the appliance. This number may be important for troubleshooting.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-4779033]To modify the appliance information:
 
    [bookmark: pgfId-6955681]Access: Admin
 
    
 
    [bookmark: pgfId-4779049]Step 1 Select System > Local > Configuration.
 
    [bookmark: pgfId-4779131]The Information page appears.
 
    [bookmark: pgfId-6801162]Step 2 To change the appliance name, type a new name in the Name field.
 
    [bookmark: pgfId-4778991]The name must be alphanumeric characters and cannot be composed of numeric characters only.
 
    [bookmark: pgfId-4779267]Step 3 To save your changes, click Save.
 
    [bookmark: pgfId-8348847]The page refreshes and your changes are saved.
 
    [bookmark: pgfId-8549729]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8348848][bookmark: 93876]Using Custom HTTPS Certifi[bookmark: marker-8387995]cates
 
    [bookmark: pgfId-8348849]License: Any
 
    [bookmark: pgfId-8348692]Cisco Defense Centers and managed devices that support web-based user interfaces include default SSL (Secure Sockets Layer) certificates that you can use to initiate an encrypted communication channel between your web browser and the appliance. However, because the default certificate for an appliance is not generated by a certificate authority (CA) trusted by any globally known CA, you can replace it with a custom certificate signed by a globally known or internally trusted CA. 
 
    [bookmark: pgfId-8348573]You can manage certificates through the local configuration for your appliance. For more information, see the following:
 
     
     	 [bookmark: pgfId-8348558]Viewing the Current HTTPS Server Certificate
 
     	 [bookmark: pgfId-8348892]Generating a Server Certificate Request
 
     	 [bookmark: pgfId-8348920]Uploading Server Certificates
 
     	 [bookmark: pgfId-8357336]Requiring User Certificates
 
    
 
     
      [bookmark: pgfId-8348041][bookmark: 26504]Viewing the Current HTTPS Ser[bookmark: marker-8388000]ver Certificate
 
     [bookmark: pgfId-8323226]License: Any
 
     [bookmark: pgfId-7886129]You can view details from the server certificate currently in place for your appliance. The certificate provides the following information:
 
     [bookmark: pgfId-7886163]
 
      
       
        
        [bookmark: pgfId-7886132]Table 64-3 HTTPS Server Certificate Information 
 
        
        
         
         	 
           
           [bookmark: pgfId-7886136]Field 
          
  
         	 
           
           [bookmark: pgfId-7886138]Description 
          
  
        
 
         
         	[bookmark: pgfId-7886140]Subject
  
         	[bookmark: pgfId-7886142]For the appliance where the certificate is installed, provides the commonName, countryName, organizationName, and organizationalUnitName.
  
        
 
         
         	[bookmark: pgfId-7886144]Issuer
  
         	[bookmark: pgfId-7886146]For the appliance that issued the certificate, provides the commonName, countryName, organizationName, and organizationalUnitName.
  
        
 
         
         	[bookmark: pgfId-7886148]Validity
  
         	[bookmark: pgfId-7886150]Indicates the timeframe during which the certificate is valid.
  
        
 
         
         	[bookmark: pgfId-7886152]Version
  
         	[bookmark: pgfId-7886154]Indicates the certificate version. 
  
        
 
         
         	[bookmark: pgfId-7886156]Serial Number
  
         	[bookmark: pgfId-7886158]Indicates the certificate serial number.
  
        
 
         
         	[bookmark: pgfId-7886160]Signature Algorithm
  
         	[bookmark: pgfId-7886162]Indicates the algorithm used to sign the certificate. 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7886164]To view the certificate details:
 
     [bookmark: pgfId-7886165]Access: Admin
 
     
 
     [bookmark: pgfId-7886166]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-7886167]The Information page appears.
 
     [bookmark: pgfId-7886168]Step 2 Click HTTPS Certificate.
 
     [bookmark: pgfId-7886169]The HTTPS Certificate page appears, with the details of the current certificate for the appliance.
 
     [bookmark: pgfId-8549752]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7886175][bookmark: 36276]Generating a Server Certif[bookmark: marker-8388007]icate Request
 
     [bookmark: pgfId-8323241]License: Any
 
     [bookmark: pgfId-7886187]You can generate a certificate request based on your appliance information and the identification information you supply. You can send the resulting request to a certificate authority to request a server certificate. You can also use it to self-sign a certificate if you have an internal certificate authority (CA) installed that is trusted by your browser. The generated key is in Base-64 encoded PEM format.
 
     [bookmark: pgfId-7886188]Note that when you generate a certificate request through the local configuration HTTPS Certificate page, you can only generate a certificate for a single server. You must type the fully qualified domain name of the server exactly as it should appear in the certificate in the Common Name field. If the common name and the DNS host name do not match, you receive a warning when connecting to the appliance. Similarly, if you install a certificate that is not signed by a globally known or internally trusted CA, you receive a security warning when you connect to the appliance.
 
     [bookmark: pgfId-7886190]To generate a certificate request:
 
     [bookmark: pgfId-7886191]Access: Admin
 
     
 
     [bookmark: pgfId-7886192]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-7886193]The Information page appears.
 
     [bookmark: pgfId-7886194]Step 2 Click HTTPS Certificate.
 
     [bookmark: pgfId-7886195]The HTTPS Certificate page appears.
 
     [bookmark: pgfId-7886196]Step 3 Click Generate New CSR.
 
     [bookmark: pgfId-7886197]The Generate Certificate Signing Request pop-up window appears.
 
     [bookmark: pgfId-7886202]Step 4 Type the two-letter country code for your country in the Country Name (two-letter code) field. 
 
     [bookmark: pgfId-7886203]Step 5 Type the postal abbreviation for your state or province in the State or Province field.
 
     [bookmark: pgfId-7886204]Step 6 Type the name of your Locality or City.
 
     [bookmark: pgfId-7886205]Step 7 Type your Organization name. 
 
     [bookmark: pgfId-7886206]Step 8 Type an Organizational Unit (Department) name. 
 
     [bookmark: pgfId-7886207]Step 9 Type the fully qualified domain name of the server for which you want to request a certificate in the Common Name field, exactly as you want it to appear in the certificate. 
 
     [bookmark: pgfId-7886208]Step 10 Click Generate. 
 
     [bookmark: pgfId-7886209]The Certificate Signing Request pop-up window appears. 
 
     [bookmark: pgfId-7886210]Step 11 Open a text editor. 
 
     [bookmark: pgfId-7886211]Step 12 Copy the entire block of text in the certificate request, including the BEGIN CERTIFICATE REQUEST and END CERTIFICATE REQUEST lines, and paste it into a blank text file.
 
     [bookmark: pgfId-7886212]Step 13 Save the file as servername.csr, where servername is the name of the server where you plan to use the certificate. 
 
     [bookmark: pgfId-7886214]Step 14 Upload the CSR file to the certificate authority where you want to request a certificate or use the CSR to create a self-signed certificate. 
 
     [bookmark: pgfId-8549774]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7886216][bookmark: 22697]Uploading Server Cer[bookmark: marker-8388014]tificates
 
     [bookmark: pgfId-8388300]License: Any
 
     [bookmark: pgfId-7886217]After you have a signed certificate from a certificate authority (CA), you can upload it. If the signing authority that generated the certificate requires you to trust an intermediate CA, you must also supply a certificate chain, sometimes referred to as a certificate path. If you require user certificates, they must be generated by a certificate authority whose intermediate authority is included in the certificate chain.
 
     [bookmark: pgfId-7886218]To upload a certificate:
 
     [bookmark: pgfId-7886219]Access: Admin
 
     
 
     [bookmark: pgfId-7886220]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-7886221]The Information page appears.
 
     [bookmark: pgfId-7886222]Step 2 Click HTTPS Certificate.
 
     [bookmark: pgfId-7886223]The HTTPS Certificate page appears.
 
     [bookmark: pgfId-7886224]Step 3 Click Import HTTPS Certificate.
 
     [bookmark: pgfId-7886225]The Import HTTPS Certificate pop-up window appears. 
 
     [bookmark: pgfId-7886230]Step 4 Open the server certificate in a text editor, copy the entire block of text, including the BEGIN CERTIFICATE and END CERTIFICATE lines, and paste it into the Server Certificate field.
 
     [bookmark: pgfId-7886231]Step 5 Optionally, open the private key file, copy the entire block of text, including the BEGIN RSA PRIVATE KEY and END RSA PRIVATE KEY lines, and paste it into the Private Key field. 
 
     [bookmark: pgfId-7886233]Step 6 Open any intermediate certificates you need to provide, copy the entire block of text, for each, and paste it into the Certificate Chain field.
 
     [bookmark: pgfId-7886234]Step 7 Click Save to upload the certificate.
 
     [bookmark: pgfId-8529153]The certificate uploads and the HTTPS Certificate page updates to reflect the new certificate.
 
     [bookmark: pgfId-8549834]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8529156][bookmark: 26601]Requiring User Cert[bookmark: marker-8529155]ificates
 
     [bookmark: pgfId-8529157]License: Any
 
     [bookmark: pgfId-8359146]You can restrict access to the FireSIGHT System web server using client browser certificate checking. When you enable user certificates, the web server checks that a user’s browser client has a valid user certificate selected. That user certificate must be generated by the same trusted certificate authority used for the server certificate. If the user selects a certificate in the browser that is not valid or not generated by a certificate authority in the certificate chain on the device, the browser cannot load the web interface.
 
     [bookmark: pgfId-8350714]You can also load a certificate revocation list (CRL) for the server. The CRL lists any certificates that have been revoked by the certificate authority, so the web server can verify that the client browser certificate has not been revoked. If the user selects a certificate that is listed in the CRL as a revoked certificate, the browser cannot load the web interface. The appliance supports upload of CRLs in Distinguished Encoding Rules (DER) format. You can only load one CRL for a server. 
 
     [bookmark: pgfId-8352301]To ensure that the list of revoked certificates stays current, you can create a scheduled task to update the CRL. The most recent refresh of the CRL is listed in the interface.
 
     [bookmark: pgfId-8377125]Make sure you use the same certificate authority used for the server certificate and that you have uploaded the intermediate certificate for the certificates. For more information, see Uploading Server Certificates.
 
      
       
     
 
     
 
     [bookmark: pgfId-8632364]Note You must have a valid user certificate present in your browser (or a CAC inserted in your reader) to enable user certificates and to access the web interface after doing so.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8529967]To require valid user certificates:
 
     [bookmark: pgfId-8353027]Access: Admin
 
     
 
     [bookmark: pgfId-8353053]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-8353209]The Information page appears.
 
     [bookmark: pgfId-8379700]Step 2 Click HTTPS Certificate.
 
     [bookmark: pgfId-8353210]The HTTPS Certificate page appears.
 
     [bookmark: pgfId-8353260]Step 3 Select Enable User Certificates. If prompted, select the appropriate certificate from the drop-down list.
 
     [bookmark: pgfId-8353355]The Enable Fetching of CRL option appears.
 
     [bookmark: pgfId-8353487]Step 4 Optionally, select Enable Fetching of CRL.
 
     [bookmark: pgfId-8353533]The remaining CRL configuration options appear.
 
     [bookmark: pgfId-8355601]Step 5 Type a valid URL to an existing CRL file and click Refresh CRL.
 
     [bookmark: pgfId-8355770]The current CRL at the supplied URL loads to the server.
 
      
       
     
 
     
 
     [bookmark: pgfId-8355780]Note Enabling fetching of the CRL creates a scheduled task to update the CRL on a regular basis. Edit the task to set the frequency of the update. For more information, see Automating Certificate Revocation List Downloads.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8355731]Step 6 Verify that you have a valid user certificate generated by the same certificate authority that created the server certificate. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8356706] 
      Caution When you save a configuration with enabled user certificates, if you do not have a valid user certificate in your browser certificate store, you disable all web server access to the appliance. Make sure you have a valid certificate installed before saving settings. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8356117]Step 7 To apply the user certificate configuration to the web server, click Save.
 
     [bookmark: pgfId-8377439]Note that you can disable user certificate enforcement via the command line if you enable certificates and find that your user certificate does not enable access. For more information, see disable-http-user-cert.
 
     [bookmark: pgfId-8549850]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-8355604][bookmark: 55103]Enabling Ac[bookmark: marker-8420740]cess to the Database
 
    [bookmark: pgfId-8323257]License: Any
 
    [bookmark: pgfId-8323264]You can configure the Defense Center to allow read-only access to its database by a third-party client. This allows you to query the database using SQL using any of the following:
 
     
     	 [bookmark: pgfId-8323265]industry-standard reporting tools such as Actuate BIRT, JasperSoft iReport, or Crystal Reports
 
     	 [bookmark: pgfId-8323266]any other reporting application (including a custom application) that supports JDBC SSL connections
 
     	 [bookmark: pgfId-8323270]the Cisco-provided command-line Java application called RunQuery, which you can either run interactively or use to obtain comma-separated results for a single query
 
    
 
    [bookmark: pgfId-8323271]From the Database Settings local configuration page, you can enable database access and create an access list that allows selected hosts to query the database. Note that this access list does not also control appliance access. For more information on appliance access lists, see Configuring the Access List for Your Appliance.
 
    [bookmark: pgfId-8395169]You can also download a package that contains the following:
 
     
     	 [bookmark: pgfId-8323275]RunQuery, the Cisco-provided database query tool
 
     	 [bookmark: pgfId-8323278]InstallCert, a tool you can use to retrieve and accept the SSL certificate from the Defense Center you want to access
 
     	 [bookmark: pgfId-8323280]the JDBC driver you must use to connect to the database
 
    
 
    [bookmark: pgfId-8323281]Note that when you connect to the database from an external client you must provide a username and password that match those for an Administrator or External Database user on the Defense Center. For more information, see Adding New User Accounts.
 
    [bookmark: pgfId-8323291]For detailed information on configuring external access to the FireSIGHT System database, including information on the database schema and supported queries, see the FireSIGHT System Database Access Guide.
 
    [bookmark: pgfId-8323297]To enable database access:
 
    [bookmark: pgfId-8323298]Access: Admin
 
    
 
    [bookmark: pgfId-8323299]Step 1 Select System > Local > Configuration.
 
    [bookmark: pgfId-8323300]The Information page appears.
 
    [bookmark: pgfId-8323301]Step 2 Click Database.
 
    [bookmark: pgfId-8323302]The Database Settings page appears.
 
    [bookmark: pgfId-8395021]Step 3 Select the Allow External Database Access check box.
 
    [bookmark: pgfId-8395022]The Access List field appears. See step 6 for more information.
 
    [bookmark: pgfId-8395026]Step 4 Type the fully qualified domain name (FQDN), IPv4 address, or IPv6 address of the Defense Center in the Server Hostname field, depending on your third-party application requirements.
 
    [bookmark: pgfId-8323321]If you type a FQDN, you must make sure that the client can resolve the FQDN of the Defense Center. If you type an IP address, you must make sure that the client can connect to the Defense Center using the IP address.
 
    [bookmark: pgfId-8323322]Step 5 Next to Client JDBC Driver, click Download and follow your browser’s prompts to download the client.zip package.
 
    [bookmark: pgfId-8323326]See the FireSIGHT System Database Access Guide for information on using the tools in the package you downloaded to configure database access.
 
    [bookmark: pgfId-8323327]Step 6 [bookmark: 31814]To add database access for one or more IP addresses, click Add Hosts.
 
    [bookmark: pgfId-8394230]An IP Address field appears in the Access List field.
 
    [bookmark: pgfId-8394313]Step 7 In the IP Address field, you have the following options, depending on the IP addresses you want to add: 
 
     
      
      	 [bookmark: pgfId-8394314]an exact IP address (for example, 192.168.1.101)
 
      	 [bookmark: pgfId-8394315]an IP address block using CIDR notation (for example, 192.168.1.1/24)
 
     
 
    
 
    [bookmark: pgfId-8394321]For information on using CIDR in the FireSIGHT System, see IP Address Conventions.
 
     
      
      	 [bookmark: pgfId-8394323] any , to designate any IP address
 
     
 
    
 
    [bookmark: pgfId-8394305]Step 8 Click Add.
 
    [bookmark: pgfId-8394415]The IP address is added to the database access list. 
 ). 
    
 
    [bookmark: pgfId-8394167]Step 10 Click Save.
 
    [bookmark: pgfId-8323328]Your database access settings are saved.
 
     
      
    
 
    
 
    [bookmark: pgfId-8323329]Tip Click Refresh to revert to the last saved database settings.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8549862]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8632434][bookmark: 40797]Configu[bookmark: marker-8632432]ring Management Interfaces
 
    [bookmark: pgfId-8632439]License: Any
 
    [bookmark: pgfId-8632440]When you first set up an appliance, you configure its network settings so that it can communicate on your internal, protected management network. You can change any network settings you created when you first set up your appliance and configure additional network settings, such as proxies. On Series 3 appliances and virtual Defense Centers, you can enable traffic channels and configure additional management interfaces to improve performance, and create routes to manage and isolate traffic between the Defense Center and devices on different networks. On Series 3 devices, you can also enable or disable LCD panel access on the device. To change these settings and to configure additional network settings such as proxies, use the Management Interfaces page (System > Local > Configuration, then click Management Interfaces).
 
     
      
    
 
    
 
    [bookmark: pgfId-8632453]Note You must use command-line tools to modify network and proxy settings for virtual devices, and to modify network settings for Cisco NGIPS for Blue Coat X-Series. Note that Cisco NGIPS for Blue Coat X-Series does not support a proxy. For more information, see the FireSIGHT System Virtual Installation Guide and the Cisco NGIPS for Blue Coat X-Series Installation and Configuration Guide.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8632466]See the following sections for configuration options and procedures:
 
     
     	 [bookmark: pgfId-8632470]Understanding Management Interface Options
 
     	 [bookmark: pgfId-8632474]Editing Management Interfaces
 
    
 
     
      [bookmark: pgfId-8632476][bookmark: 53136]Understanding Management Interface Options
 
     [bookmark: pgfId-8632477]You may want to change your settings to improve performance, enable different functionality, or otherwise alter the network configuration in your deployment. On Series 3 appliances, you can also configure traffic channels, enable an additional management interface, and create a route to isolate traffic from devices on different networks. For more information, see Understanding Management Interfaces. 
 
    
 
     
      [bookmark: pgfId-8632484]Interfaces
 
     [bookmark: pgfId-8632488]The FireSIGHT System provides a dual stack implementation for both IPv4 and IPv6 management environments. You can choose one or both protocols; disable the protocol (if any) you do not want to use.
 
     [bookmark: pgfId-8632489]For each management protocol, you must specify the IP address of the default (eth0) management interface, a netmask or prefix length, and the default gateway. You can either set these manually or configure the appliance to retrieve them from a local DHCP server or IPv6 router. Note that you must manually configure each additional (eth1 and so on) management interface that you enable.
 
     [bookmark: pgfId-8632490]You can configure the following options on your management interface:
 
      
      	 [bookmark: pgfId-8632491] Enabled - enables the management interface. Do  not disable the default management interface until after you have already enabled and saved another management interface.
 
      	 [bookmark: pgfId-8632492] Channels - enables the  Management Traffic and  Event Traffic channels on the interface.
 
     
 
     [bookmark: pgfId-8632493]You can enable the traffic channels (management traffic, event traffic, or both) to create different connections in the communication channel on the management interface. In addition, you can separate traffic channels over multiple management interfaces, combining the throughput of both interfaces to further improve performance. For more information, see Understanding Management Interfaces.
 
      
      	 [bookmark: pgfId-8632497] Mode - allows you to change the default Autonegotiation or specify a link mode. Note that any changes you make to the Auto Negotiate value are ignored for Gigabit interfaces.
 
     
 
     [bookmark: pgfId-8632504]Note that when you register an 8000 Series managed device to your Defense Center, you must either auto-negotiate on both sides of the connection, or set both sides to the same static speed to ensure a stable network link. 8000 Series managed devices do not support half duplex network links; they also do not support differences in speed or duplex configurations at opposite ends of a connection.
 
      
      	 [bookmark: pgfId-8632508] MTU - allows you to change the default setting.
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8674914]Note Unlike other interfaces, changing the maximum transmission unit (MTU) on a management interface does not interrupt traffic.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8674918]The following table lists MTU configuration ranges for management interfaces:
 
     [bookmark: pgfId-8632545]
 
      
       
        
        [bookmark: pgfId-8632513]Table 64-4 Management Interface MTU Range by Device
 
        
        
         
         	 
           
           [bookmark: pgfId-8632517]On the Model Device... 
          
  
         	 
           
           [bookmark: pgfId-8632519]the MTU range is.... 
          
  
        
 
         
         	[bookmark: pgfId-8632524]Series 2 except 3D6500 and 3D9900
  
         	[bookmark: pgfId-8632526]576-1518
  
        
 
         
         	[bookmark: pgfId-8632528]3D6500, 3D9900, virtual
  
         	[bookmark: pgfId-8632530]576-9018
  
        
 
         
         	[bookmark: pgfId-8632535]Series 3 default (eth0)
  
         	[bookmark: pgfId-8632537]576-9234
  
        
 
         
         	[bookmark: pgfId-8632542]Series 3 non-default (eth1 and so on)
  
         	[bookmark: pgfId-8632544]1518-9018
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8632546]Because the system automatically trims 18 bytes from the configured MTU value, any value below 1298 does not comply with the minimum IPv6 MTU setting of 1280, and any value below 594 does not comply with the minimum IPv4 MTU setting of 576. For example, the system automatically trims a configured value of 576 to 558.
 
      
       
       	 [bookmark: pgfId-8632547] MDI/MDIX -  allows you to change the default  Auto-MDIX setting.
 
       	 [bookmark: pgfId-8632548] IPv4 Configuration - allows you to configure select  Static ,  DHCP , or  Disabled .
 
      
 
     
 
     [bookmark: pgfId-8632549] – Select Static to enter the IPv4 management IP address and netmask. 
 
     [bookmark: pgfId-8632550] – Select DHCP to retrieve network settings from a DHCP server. (eth0 only)
 
     [bookmark: pgfId-8632551] – Select Disabled to disable the protocol. Do not disable both IPv4 and IPv6.
 
      
       
       	 [bookmark: pgfId-8632552] IPv6 Configuration - allows you to configure  Static ,  DHCP ,  Router  Assigned , or  Disabled .
 
      
 
     
 
     [bookmark: pgfId-8632553] – Select Static to enter the IPv4 management IP address and netmask. 
 
     [bookmark: pgfId-8632554] – Select DHCP to retrieve network settings from a DHCP server. (eth0 only)
 
     [bookmark: pgfId-8632555] – Select Router Assigned to retrieve network settings from a local IPv6 router.
 
     [bookmark: pgfId-8632556] – Select Disabled to disable the protocol. Do not disable both IPv4 and IPv6.
 
    
 
     
      [bookmark: pgfId-8632558][bookmark: 74881]Routes
 
     [bookmark: pgfId-8632559]You can view or edit the route to your default management interface when you click the Edit icon, or view the route statistics when you click the View icon. 
 
     [bookmark: pgfId-8632560]You can create a new route to an additional network. Click the Add icon to display a pop-up window where you can enter the destination network IP address, netmask or prefix length, interface dropdown (eth0 and so on) and the gateway. The following examples show some ways you can use a route to a different network:
 
      
      	 [bookmark: pgfId-8632566]On a Defense Center, you can create a route to a device on a different network to allow one Defense Center to manage and isolate traffic from devices on different networks.
 
      	 [bookmark: pgfId-8632571]On a device, you can create a route and register your device to Defense Centers on two different networks to configure high availability for Defense Centers over a wider deployment.
 
     
 
     [bookmark: pgfId-8632575]You can configure the following settings on a specific management interface to create a route to a network:
 
      
       
       	 [bookmark: pgfId-8632576] Destination - the destination address of the network to which you want to create a route.
 
       	 [bookmark: pgfId-8632577] Netmask or  Prefix  Length - the netmask (IPv4) or prefix length (IPv6) for the network
 
       	 [bookmark: pgfId-8632578] Interface - the management interface on the appliance assigned to the new route.
 
       	 [bookmark: pgfId-8632579] Gateway - the gateway for the new network.
 
      
 
     
 
    
 
     
      [bookmark: pgfId-8632581][bookmark: 44729]Shared Settings
 
     [bookmark: pgfId-8632582]Regardless of your management environment, you can specify up to three DNS servers, as well as the host name and domain for the device. 
 
     [bookmark: pgfId-8632586]You can change the management port. FireSIGHT System appliances communicate using a two-way, SSL-encrypted communication channel, which by default is on port 8305. Although Cisco strongly recommends that you keep the default setting, if the management port conflicts with other communications on your network, you can choose a different port.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8632590] 
      Caution If you change the management port, you must change it for all appliances in your deployment that need to communicate with each other. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-8632592][bookmark: 66093]LCD Panel
 
     [bookmark: pgfId-8632596]Series 3 devices allow you view device information using an LCD panel on the front of the device. On the Series 3 Management Interfaces page, you can allow people to change network settings using the LCD panel.
 
     [bookmark: pgfId-8665534]If you edit the IP address of a managed device using the LCD panel, confirm that the changes are reflected on the managing Defense Center. In some cases, you may need to edit the device management settings manually. For more information, see Editing Device Management Settings.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8632600] 
      Caution Allowing reconfiguration using the LCD panel can present a security risk. You need only physical access, not authentication, to configure network settings using the LCD panel. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-8632602][bookmark: 57376]Proxy
 
     [bookmark: pgfId-8632606]All FireSIGHT System appliances are configured to directly connect to the Internet on ports 443/tcp (HTTPS) and 80/tcp (HTTP); see Security, Internet Access, and Communication Ports. With the exception of Cisco NGIPS for Blue Coat X-Series, FireSIGHT System appliances support the use of a proxy server, to which you can authenticate via HTTP Digest.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8666530] 
      Caution Proxies that use NT LAN Manager (NTLM) authentication cannot communicate with the Collective Security Intelligence Cloud to receive information. Make sure to configure a different authentication for your proxy if you want to use cloud-based features. For more information, see 
      Enabling Cloud Communications. 
       
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-8632617][bookmark: 85493]Editing Management Interfaces
 
     [bookmark: pgfId-8632621]License: Any
 
     [bookmark: pgfId-8627704]You can use the Management Interfaces page to modify the default settings for the default management interface on your Defense Center. On Series 3 appliances and virtual Defense Centers, you can also enable and configure traffic channels and additional management interfaces. Any changes you make to the Auto Negotiate value are ignored for Gigabit interfaces.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8632637] 
      Caution Do not modify the settings for the management interface unless you have physical access to the appliance. It is possible to select a setting that makes it difficult to access the web interface. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8632639]To edit a management interface:
 
     [bookmark: pgfId-8632643]Access: Admin
 
     
 
     [bookmark: pgfId-8632644]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-8632645]The Information page appears.
 
     [bookmark: pgfId-8632646]Step 2 Click Management Interfaces.
 
     [bookmark: pgfId-8632649]The Management Interfaces page appears, listing the current settings for each interface on your Defense Center.
 
     [bookmark: pgfId-8632651]Step 3 Optionally, under Interfaces, click Edit next to the interface that you want to configure.
 
     [bookmark: pgfId-8632652]You can modify the default management interface (eth0) or enable and configure an additional management interface (eth1 and so on). For each additional management interface, you must assign a unique, static IP address (IPv4 or IPv6) or hostname. You can select which traffic channels to carry, in addition to setting the mode, link, MTU, and IP configuration.
 
     [bookmark: pgfId-8632653]Step 4 Optionally, under Routes, enter the destination network IP address, netmask or prefix length, and gateway, and specify the management interface you want to use for this network route.
 
     [bookmark: pgfId-8632654]You can also view the route statistics when you click the magnifying glass icon.
 
     [bookmark: pgfId-8632655]Step 5 Optionally, under Shared Settings, specify network settings that do not depend on the management network protocol.
 
     [bookmark: pgfId-8632656]You can specify up to three DNS servers, as well as the host name and domain for the appliance. Note that if you selected DHCP in the previous step, you cannot manually specify these shared settings. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8632660] 
      Caution Cisco 
      strongly recommends that you keep the default setting, but if the management port conflicts with other communications on your network, you can choose a different port. If you change the management port, you must change it for 
      all appliances in your deployment that need to communicate with each other. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8632664]Step 6 Optionally, on Series 3 devices, under LCD Panel, select the Allow reconfiguration of network settings check box to enable changing network settings using the device’s LCD panel.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8632665] 
      Caution Allowing reconfiguration using the LCD panel can present a security risk. You need only physical access, not authentication, to configure network settings using the LCD panel. The web interface warns you that enabling this option is a potential security issue. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8632666]Step 7 Optionally, under Proxy, select the check box to enable proxy, and then:
 
      
       
       	 [bookmark: pgfId-8632667]Enter the IP address or fully qualified domain name of your proxy server in the  HTTP Proxy field. Enter the port in the  Port field. 
 
       	 [bookmark: pgfId-8632668]Optionally, supply authentication credentials by selecting  Use Proxy Authentication then providing a  User Name and  Password .
 
      
 
     
 
     [bookmark: pgfId-8632669]Step 8 When you are finished configuring the appliance’s network settings, click Save.
 
     [bookmark: pgfId-8632670]The network settings are changed. If you changed the appliance’s hostname, the new name is not reflected in the syslog until after you reboot the appliance.
 
     [bookmark: pgfId-8632671]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-8323492][bookmark: 36435]Shutting Down and[bookmark: marker-8323490] Restarting the System
 
    [bookmark: pgfId-8323504]License: Any
 
    [bookmark: pgfId-8323505]You have several options for controlling the processes on your appliance. You can:
 
     
     	 [bookmark: pgfId-8323506]shut down the appliance
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8679145] 
     Caution Do 
     not shut off appliances using the power button; it may cause a loss of data. Shut down appliances completely via the Appliance Process page. 
      
      
 
     
 
    
 
     
     	 [bookmark: pgfId-8323507]reboot the appliance
 
     	 [bookmark: pgfId-8367272]restart communications, database, and HTTP server processes on the appliance (this is typically used during troubleshooting)
 
     	 [bookmark: pgfId-8367273]restart the Snort process
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8678921] 
     Caution Restarting the Snort process temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8323520]To shut down or restart your appliance:
 
    [bookmark: pgfId-8323521]Access: Admin
 
    
 
    [bookmark: pgfId-8323522]Step 1 Select System > Local > Configuration.
 
    [bookmark: pgfId-8323523]The Information page appears.
 
    [bookmark: pgfId-8323524]Step 2 Click Process.
 
    [bookmark: pgfId-8323528]The Appliance Process page appears.
 
    [bookmark: pgfId-8380433]Step 3 Specify the command you want to perform:
 
    [bookmark: pgfId-8380437]On Defense Centers:
 
     
      
      	 [bookmark: pgfId-8380421]To shut down the appliance, click  Run Command next to  Shutdown   Defense Center .
 
      	 [bookmark: pgfId-8323551]To reboot the appliance, click  Run Command next to  Reboot   Defense Center . Note that this logs you out of the Defense Center.
 
      	 [bookmark: pgfId-8323561]To restart the appliance, click  Run Command next to  Restart   Defense Center  Console . Note that restarting the Defense Center may cause deleted hosts to reappear in the network map.
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-8654814]Note When you reboot your Defense Center, the system runs a database check that can take up to an hour to complete.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8380480]On managed devices:
 
     
      
      	 [bookmark: pgfId-8323572]To shut down the appliance, click  Run Command next to  Shutdown Appliance .
 
      	 [bookmark: pgfId-8323573]To reboot the appliance, click  Run Command next to  Reboot Appliance . Note that this logs you out of the device.
 
      	 [bookmark: pgfId-8323580]To restart the appliance, click  Run Command next to  Restart Appliance Console .
 
      	 [bookmark: pgfId-8371877]To restart the Snort process, click  Run Command next to  Restart Snort .
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-8655145]Note When you reboot your managed device, the system runs a database check that can take up to an hour to complete.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8550020]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8323744][bookmark: 41970][bookmark: 82924]Setting th[bookmark: marker-8323742]e Time Manually
 
    [bookmark: pgfId-8323760]License: Any
 
    [bookmark: pgfId-8323765]If the Time Synchronization setting in the currently applied system policy is set to Manually in Local Configuration, then you can manually set the time for the appliance using the Time page in the local configuration. 
 
    [bookmark: pgfId-8485792]You must use native applications, such as command line interfaces or the operating system interface, to manage time settings for Cisco NGIPS for Blue Coat X-Series. For more information, see the Cisco NGIPS for Blue Coat X-Series Installation Guide.
 
    [bookmark: pgfId-8323766]If the appliance is synchronizing its time based on NTP, you cannot change the time manually. Instead, the NTP Status section on the Time page provides the following information:
 
    [bookmark: pgfId-5104439]
 
     
      
       
       [bookmark: pgfId-5104402]Table 64-5 [bookmark: 82598]NTP Status 
 
       
       
        
        	 
          
          [bookmark: pgfId-5104406]Column 
         
  
        	 
          
          [bookmark: pgfId-5104408]Description 
         
  
       
 
        
        	[bookmark: pgfId-5104410]NTP Server
  
        	[bookmark: pgfId-5104412]The IP address and name of the configured NTP server.
  
       
 
        
        	[bookmark: pgfId-5104414]Status
  
        	[bookmark: pgfId-5104416]The status of the NTP server time synchronization. The following states may appear:
 
          
          	 [bookmark: pgfId-5104420] Being Used indicates that the appliance is synchronized with the NTP server.
 
          	 [bookmark: pgfId-5104421] Available indicates that the NTP server is available for use, but time is not yet synchronized.
 
          	 [bookmark: pgfId-5104422] Not Available indicates that the NTP server is in your configuration, but the NTP daemon is unable to use it.
 
          	 [bookmark: pgfId-5104423] Pending indicates that the NTP server is new or the NTP daemon was recently restarted. Over time, its value should change to  Being Used ,  Available , or  Not Available .
 
          	 [bookmark: pgfId-5104424] Unknown indicates that the status of the NTP server is unknown.
 
         
  
       
 
        
        	[bookmark: pgfId-5104426]Offset
  
        	[bookmark: pgfId-5104428]The number of milliseconds of difference between the time on the appliance and the configured NTP server. Negative values indicate that the appliance is behind the NTP server, and positive values indicate that it is ahead.
  
       
 
        
        	[bookmark: pgfId-5104436]Last Update
  
        	[bookmark: pgfId-5104438]The number of seconds that have elapsed since the time was last synchronized with the NTP server. The NTP daemon automatically adjusts the synchronization times based on a number of conditions. For example, if you see larger update times such as 300 seconds, that indicates that the time is relatively stable and the NTP daemon has determined that it does not need to use a lower update increment. 
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8323774]See Synchronizing Time for more information about the time settings in the system policy.
 
    [bookmark: pgfId-5104694]To manually configure the time:
 
    [bookmark: pgfId-6955855]Access: Admin
 
    
 
    [bookmark: pgfId-5081467]Step 1 Select System > Local > Configuration. 
 
    [bookmark: pgfId-5081468]The Information page appears.
 
    [bookmark: pgfId-5081685]Step 2 Click Time.
 
    [bookmark: pgfId-5081488]The Time page appears.
 
    [bookmark: pgfId-5081493]Step 3 Select the following from the Set Time drop-down lists:
 
     
      
      	 [bookmark: pgfId-5081494]year
 
      	 [bookmark: pgfId-5081495]month
 
      	 [bookmark: pgfId-5081496]day
 
      	 [bookmark: pgfId-5081497]hour
 
      	 [bookmark: pgfId-5081498]minute
 
     
 
    
 
    [bookmark: pgfId-5082145]Step 4 Click Apply.
 
    [bookmark: pgfId-8657049]The time is updated. For information about changing your time zone, see Setting Your Default Time Zone.
 
    [bookmark: pgfId-8657054]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8323873][bookmark: 56914][bookmark: 57431]Manag[bookmark: marker-8323871]ing Remote Storage
 
    [bookmark: pgfId-8323879]License: Any
 
    [bookmark: pgfId-8323886]On Defense Centers, you can use local or remote storage for backups and reports. You can use Network File System (NFS), Secure Shell (SSH), or Server Message Block (SMB)/Common Internet File System (CIFS) for backup and report remote storage. You cannot send backups to one remote system and reports to another, but you can choose to send either to a remote system and store the other on the local Defense Center. For information on backup and restore, see Using Backup and Restore.
 
     
      
    
 
    
 
    [bookmark: pgfId-8323893]Tip After configuring and selecting remote storage, you can switch back to local storage only if you have not increased the connection database limit.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8323897]You must ensure that your external remote storage system is functional and accessible from the Defense Center.
 
    [bookmark: pgfId-8323904]Select one of the backup and report storage options:
 
     
     	 [bookmark: pgfId-8323910]To disable external remote storage and use the local Defense Center for backup and report storage, see Using Local Storage.
 
     	 [bookmark: pgfId-8323918]To use NFS for backup and report storage, see Using NFS for Remote Storage.
 
     	 [bookmark: pgfId-8323922]To use secure shell (SCP) via SSH for backup and report storage, see Using SSH for Remote Storage.
 
     	 [bookmark: pgfId-8365367]To use SMB for backup and report storage, see Using SMB for Remote Storage.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-8486825]Note You cannot use remote backup and restore to manage data on Cisco NGIPS for Blue Coat X-Series.
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-8365372][bookmark: 83490]Using Local St[bookmark: marker-8365371]orage
 
     [bookmark: pgfId-8365373]License: Any
 
     [bookmark: pgfId-8323942]You can store backups and reports on the local Defense Center.
 
     [bookmark: pgfId-8323943]To store backups and reports locally:
 
     [bookmark: pgfId-8323944]Access: Admin
 
     
 
     [bookmark: pgfId-8323945]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-8323946]The Information page appears.
 
     [bookmark: pgfId-8323947]Step 2 Click Remote Storage Device.
 
     [bookmark: pgfId-8323948]The Remote Storage Device page appears.
 
     [bookmark: pgfId-8323953]Step 3 Select Local (No Remote Storage) from the Storage Type drop-down list.
 
     [bookmark: pgfId-8323954]Step 4 Click Save.
 
     [bookmark: pgfId-8323955]Your storage location choice is saved.
 
      
       
     
 
     
 
     [bookmark: pgfId-8323956]Tip You do not use the Test button with local storage.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8550072]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8323959][bookmark: 77156]Using NFS for Re[bookmark: marker-8323958]mote Storage
 
     [bookmark: pgfId-8323964]License: Any
 
     [bookmark: pgfId-8323965]You can select Network File System (NFS) protocol to store your reports and backups. Optionally, select the Use Advanced Options check box to use one of the mount binary options as documented in an NFS mount man page.
 
     [bookmark: pgfId-8323966]To store backups and reports using NFS:
 
     [bookmark: pgfId-8323967]Access: Admin
 
     
 
     [bookmark: pgfId-8323968]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-8323969]The Information page appears.
 
     [bookmark: pgfId-8323970]Step 2 Click Remote Storage Device.
 
     [bookmark: pgfId-8323971]The Remote Storage Device page appears.
 
     [bookmark: pgfId-8323972]Step 3 Select NFS from the Storage Type drop-down list.
 
     [bookmark: pgfId-8323973]The page refreshes to display the NFS storage configuration options.
 
     [bookmark: pgfId-8323978]Step 4 Add the connection information:
 
      
       
       	 [bookmark: pgfId-8323979]Enter the IPv4 address or hostname of the storage system in the  Host field.
 
       	 [bookmark: pgfId-8381185]Enter the path to your storage area in the  Directory field.
 
      
 
     
 
     [bookmark: pgfId-8323981]Step 5 If there are any required command line options, select Use Advanced Options. 
 
     [bookmark: pgfId-8323982]A Command Line Options field appears where you can enter mount binary options. 
 
     [bookmark: pgfId-8323983]Step 6 Under System Usage, select either or both of the following:
 
      
       
       	 [bookmark: pgfId-8323984]Select Use for Backups to store backups on the designated host.
 
       	 [bookmark: pgfId-8323985]Select  Use for Reports to store reports on the designated host.
 
       	 [bookmark: pgfId-8323986]Enter  Disk Space Threshold for backup to remote storage. Default is 90%.
 
      
 
     
 
     [bookmark: pgfId-8323987]Step 7 Optionally, click Test.
 
     [bookmark: pgfId-8323991]The test ensures that the Defense Center can access the designated host and directory.
 
     [bookmark: pgfId-8323992]Step 8 Click Save.
 
     [bookmark: pgfId-8323993]Your remote storage configuration is saved.
 
     [bookmark: pgfId-8550094]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8323996][bookmark: 99299]Using SSH for Rem[bookmark: marker-8323995]ote Storage
 
     [bookmark: pgfId-8324001]License: Any
 
     [bookmark: pgfId-8324002]You can select SSH to use secure copy (SCP) to store your reports and backups. Optionally, select the Use Advanced Options check box to use one of the mount binary options as documented in a SSH mount man page.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8485294] 
      Caution If you enable STIG compliance on an appliance, you cannot use SSH for remote storage for that appliance. For more information, see 
      Enabling STIG Compliance. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8324003]To store backups and reports using SSH:
 
     [bookmark: pgfId-8324004]Access: Admin
 
     
 
     [bookmark: pgfId-8324005]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-8324006]The Information page appears.
 
     [bookmark: pgfId-8324007]Step 2 Click Remote Storage Device.
 
     [bookmark: pgfId-8324008]The Remote Storage Device page appears.
 
     [bookmark: pgfId-8324009]Step 3 At Storage Type, select SSH.
 
     [bookmark: pgfId-8324010]The page refreshes to display the SCP via SSH storage configuration options.
 
     [bookmark: pgfId-8324015]Step 4 Add the connection information:
 
      
       
       	 [bookmark: pgfId-8324016]Enter the IP address or hostname of the storage system in the  Host field.
 
       	 [bookmark: pgfId-8324017]Enter the path to your storage area in the  Directory field.
 
       	 [bookmark: pgfId-8324018]Enter the storage system’s user name in the  Username field and the password for that user in the  Password field. To specify a domain, precede the user name with the domain followed by a forward slash (/). 
 
       	 [bookmark: pgfId-8324019]To use SSH keys, copy the content of the  SSH Public Key field and place it in your authorized_keys file.
 
      
 
     
 
     [bookmark: pgfId-8324020]Step 5 If there are any required command line options, select Use Advanced Options. 
 
     [bookmark: pgfId-8324021]A Command Line Options field appears where you can enter mount binary options. 
 
     [bookmark: pgfId-8324022]Step 6 Under System Usage, select either or both of the following:
 
      
       
       	 [bookmark: pgfId-8324023]Select Use for Backups to store backups on the designated host.
 
       	 [bookmark: pgfId-8324024]Select  Use for Reports to store reports on the designated host.
 
      
 
     
 
     [bookmark: pgfId-8324025]Step 7 Optionally, click Test.
 
     [bookmark: pgfId-8324029]The test ensures that the Defense Center can access the designated host and directory.
 
     [bookmark: pgfId-8324030]Step 8 Click Save.
 
     [bookmark: pgfId-8324031]Your remote storage configuration is saved.
 
     [bookmark: pgfId-8550114]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8324034][bookmark: 98935]Using SMB for Rem[bookmark: marker-8324033]ote Storage
 
     [bookmark: pgfId-8324039]License: Any
 
     [bookmark: pgfId-8324040]You can select Server Message Block (SMB) protocol to store your reports and backups. Optionally, select the Use Advanced Options check box to use one of the mount binary options, as documented in an SMB mount man page. For example, using SMB, you can enter the security mode in the Command Line Options field using the following format:
 
      
      [bookmark: pgfId-8324041]sec=mode 
     
 
     [bookmark: pgfId-8324044]where mode is the security mode you want to use for remote storage. See the Security Mode Settings table for setting options.
 
     [bookmark: pgfId-8324087]
 
      
       
        
        [bookmark: pgfId-8324052]Table 64-6 [bookmark: 53261]Security Mode Settings 
 
        
        
         
         	 
           
           [bookmark: pgfId-8324056]Mode 
          
  
         	 
           
           [bookmark: pgfId-8324058]Description 
          
  
        
 
         
         	[bookmark: pgfId-8324060][none]
  
         	[bookmark: pgfId-8324062]Attempt to connect as null user (no name).
  
        
 
         
         	[bookmark: pgfId-8324064]krb5
  
         	[bookmark: pgfId-8324066]Use Kerberos version 5 authentication.
  
        
 
         
         	[bookmark: pgfId-8324068]krb5i
  
         	[bookmark: pgfId-8324070]Use Kerberos authentication and packet signing.
  
        
 
         
         	[bookmark: pgfId-8324072]ntlm
  
         	[bookmark: pgfId-8324074]Use NTLM password hashing. (Default)
  
        
 
         
         	[bookmark: pgfId-8324076]ntlmi
  
         	[bookmark: pgfId-8324078]Use NTLM password hashing with signing (may be Default if /proc/fs/cifs/PacketSigningEnabled is on or if server requires signing).
  
        
 
         
         	[bookmark: pgfId-8324080]ntlmv2
  
         	[bookmark: pgfId-8324082]Use NTLMv2 password hashing.
  
        
 
         
         	[bookmark: pgfId-8324084]ntlmv2i
  
         	[bookmark: pgfId-8324086]Use NTLMv2 password hashing with packet signing.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8324088]To store backups and reports using SMB:
 
     [bookmark: pgfId-8324089]Access: Admin
 
     
 
     [bookmark: pgfId-8324090]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-8324091]The Information page appears.
 
     [bookmark: pgfId-8324092]Step 2 Click Remote Storage Device.
 
     [bookmark: pgfId-8324093]The Remote Storage Device page appears.
 
     [bookmark: pgfId-8324094]Step 3 Under Storage Type, select SMB.
 
     [bookmark: pgfId-8324095]The page refreshes to display the SMB storage configuration options.
 
     [bookmark: pgfId-8324100]Step 4 Add the connection information:
 
      
       
       	 [bookmark: pgfId-8324101]Enter the IPv4 address or hostname of the storage system in the  Host field.
 
       	 [bookmark: pgfId-8368429]Enter the share of your storage area in the  Share field. Note that the system only recognizes top-level shares and not full file paths. To use the specified Share directory as a remote backup destination, it must be shared on the Windows system.
 
       	 [bookmark: pgfId-8368430]Optionally, enter the domain name for the remote storage system in the  Domain field.
 
       	 [bookmark: pgfId-8324104]Enter the user name for the storage system in the  Username field and the password for that user in the  Password field.
 
      
 
     
 
     [bookmark: pgfId-8324105]Step 5 If there are any required command line options, select Use Advanced Options. 
 
     [bookmark: pgfId-8324106]A Command Line Options field appears where you can enter the mount binary commands, such as security modes. See Security Mode Settings for more information.
 
     [bookmark: pgfId-8324110]Step 6 Under System Usage, select either or both of the following:
 
      
       
       	 [bookmark: pgfId-8324111]Select Use for Backups to store backups on the designated host.
 
       	 [bookmark: pgfId-8324112]Select  Use for Reports to store reports on the designated host.
 
      
 
     
 
     [bookmark: pgfId-8324113]Step 7 Optionally, click Test.
 
     [bookmark: pgfId-8324117]The test ensures that the Defense Center can access the designated host and directory.
 
     [bookmark: pgfId-8324118]Step 8 Click Save.
 
     [bookmark: pgfId-8324119]Your remote storage configuration is saved.
 
     [bookmark: pgfId-8550130]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-8324163][bookmark: 26322]Understanding Change Rec[bookmark: marker-8455494]onciliation
 
    [bookmark: pgfId-8324165]License: Any
 
    [bookmark: pgfId-8324166]To monitor the changes that users make and ensure that they follow your organization’s preferred standard, you can configure your system to send, via email, a detailed report of changes made to your system over the past 24 hours. Whenever a user saves changes to the system configuration, a snapshot is taken of the changes. The change reconciliation report combines information from these snapshots to present a clear summary of recent system changes.
 
    [bookmark: pgfId-8324167]The following sample graphic displays a User section of an example change reconciliation report and lists both the previous value for each configuration and the value after changes. When users make multiple changes to the same configuration, the report lists summaries of each distinct change in chronological order, beginning with the most recent.
 
    [bookmark: pgfId-8678585]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-8324176]You can view changes made during the previous 24 hours. However, to view prior changes, you must view the audit log. See Using the Audit Log to Examine Changes for more information.
 
    [bookmark: pgfId-8324180]To use the change reconciliation feature:
 
    [bookmark: pgfId-8324181]Access: Admin
 
    
 
    [bookmark: pgfId-8324182]Step 1 Select System > Local > Configuration.
 
    [bookmark: pgfId-8324183]The Information page appears.
 
    [bookmark: pgfId-8324184]Step 2 Click Change Reconciliation.
 
    [bookmark: pgfId-8324185]The Change Reconciliation page appears.
 
    [bookmark: pgfId-8324190]Step 3 Select the Enable check box.
 
    [bookmark: pgfId-8324191]Step 4 Select the time of day you want the system to send out the change reconciliation report from the Time to Run drop-down lists.
 
    [bookmark: pgfId-8324192]Step 5 In the Email to field, enter the email addresses of report recipients. At any time, you can click Resend Last Report to send recipients another copy of the most recent change reconciliation report.
 
     
      
    
 
    
 
    [bookmark: pgfId-8324193]Note To receive change reconciliation reports, you must first configure a mail relay host and notification address. For more information, see Configuring a Mail Relay Host and Notification Address.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8324197]Step 6 Optionally, select Include Policy Configuration to include records of policy changes in the change reconciliation report. This includes changes to access control, intrusion, system, health, and network discovery policies. If you do not select this option, the report will not show changes to any policies.
 
     
      
    
 
    
 
    [bookmark: pgfId-8474957]Note This option is not available on managed devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8324201]Step 7 Optionally, select Show Full Change History to include records of all changes over the past 24 hours in the change reconciliation report. If you do not select this option, the report includes only a consolidated view of changes for each category. 
 
    [bookmark: pgfId-8324202]Step 8 Click Save.
 
    [bookmark: pgfId-8324203]Your changes are saved. The report runs daily at the time you selected.
 
    [bookmark: pgfId-8550150]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8465265][bookmark: 69975]Managing R[bookmark: marker-8465263]emote Console Access
 
    [bookmark: pgfId-8672033]License: Any
 
    [bookmark: pgfId-8672037]Supported Devices: feature dependent
 
    [bookmark: pgfId-8672041]Supported Defense Centers: feature dependent
 
    [bookmark: pgfId-8476465]You can use a Linux system console for remote access on any appliance via either the VGA port (which is the default) or the serial port on the physical appliance. Choose the option most suitable to the physical layout of your organization’s Cisco deployment.
 
    [bookmark: pgfId-8476469]You can use Lights-Out Management (LOM) on the default (eth0) management interface on a Serial Over LAN (SOL) connection to remotely monitor or manage Series 3 appliances without logging into the management interface of the appliance. You can perform limited tasks, such as viewing the chassis serial number or monitoring such conditions as fan speed and temperature, using a command line interface on an out-of-band management connection. Series 2, virtual appliances, ASA FirePOWER module, and Cisco NGIPS for Blue Coat X-Series do not support LOM.
 
    [bookmark: pgfId-8368928]You must enable LOM for both the appliance and the user you want to manage the appliance. After you enable the appliance and the user, you use a third-party Intelligent Platform Management Interface (IPMI) utility to access and manage your appliance.
 
     
      
    
 
    
 
    [bookmark: pgfId-8670052]Note The baseboard management controller (BMC) for a 3D71xx, 3D82xx, or a 3D83xx device is only accessible via 1Gbps link speeds when the host is powered on. When the device is powered down the BMC can only establish Ethernet link at 10 and 100Mbps. Therefore if LOM is being used to remotely power the device, connect the device to the network using 10 and 100Mbps link speeds only.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8446885]For more information, see the following topics:
 
     
     	 [bookmark: pgfId-8446937]Configuring Remote Console Settings on the Appliance
 
     	 [bookmark: pgfId-8447815]Enabling Lights-Out Management User Access
 
     	 [bookmark: pgfId-8447826]Using a Serial Over LAN Connection
 
     	 [bookmark: pgfId-8464096]Using Lights-Out Management
 
    
 
     
      [bookmark: pgfId-8464098][bookmark: 11479]Configuring Remote Console Settings on the Appliance
 
     [bookmark: pgfId-8464120]License: Any
 
     [bookmark: pgfId-8471807]Supported Devices: feature dependent
 
     [bookmark: pgfId-8471729]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-8464122]Use the web interface of the appliance you want to remotely manage to select and configure the remote console access option you want to use.
 
     [bookmark: pgfId-8672052]Note that Series 2, virtual appliances, ASA FirePOWER module, and Cisco NGIPS for Blue Coat X-Series do not support LOM.
 
      
       
     
 
     
 
     [bookmark: pgfId-8476284]Note Before you can connect to a Series 3 device using LOM/SOL, you must disable Spanning Tree Protocol (STP) on any third-party switching equipment connected to the device’s management interface.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8369105]To configure remote console settings:
 
     [bookmark: pgfId-8369106]Access: Admin
 
     
 
     [bookmark: pgfId-8369107]Step 1 Select System > Local > Configuration.
 
     [bookmark: pgfId-8369108]The Information page appears.
 
     [bookmark: pgfId-8369109]Step 2 Select Console Configuration.
 
     [bookmark: pgfId-8369110]The Console Configuration page appears.
 
     [bookmark: pgfId-8445512]Step 3 Select a remote console access option:
 
      
       
       	 [bookmark: pgfId-8445513]Select  VGA to use the appliance’s VGA port. This is the default option.
 
       	 [bookmark: pgfId-8476449]Select  Physical Serial Port to use the appliance’s serial port, or to use LOM/SOL on a Series 3 Defense Center, 3D7050, or 8000 Series device.
 
      
 
     
 
     [bookmark: pgfId-8479471]Note that 3D2100, 3D2500, 3D3500, and 3D4500 managed devices do not have serial ports.
 
      
       
       	 [bookmark: pgfId-8476462]Select  Lights-Out Management to use LOM/SOL on a 7000 Series device (except the 3D7050). On these devices, you cannot use SOL and a regular serial connection at the same time.
 
      
 
     
 
     [bookmark: pgfId-8476446]If you selected Physical Serial Port or Lights-Out Management, the LOM settings appear. 
 
      
       
     
 
     
 
     [bookmark: pgfId-8476436]Note When you change your remote console from Physical Serial Port to Lights-Out Management or from Lights-Out Management to Physical Serial Port on the 70xx Family of devices (except the 3D7050), you may have to reboot the appliance twice to see the expected boot prompt. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8446590]Step 4 To configure LOM via SOL, enter the appropriate settings: 
 
      
       
       	 [bookmark: pgfId-8447356]DHCP  Configuration for the appliance ( DHCP or  Static ) 
 
       	 [bookmark: pgfId-8447367] IP Address to be used for LOM 
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8447460]Note The LOM IP address must be different from the management interface IP address of the appliance.
 
      
      
 
     
 
     
 
      
       
       	 [bookmark: pgfId-8447448]the  Netmask for the appliance
 
       	 [bookmark: pgfId-8447431]the  Default Gateway for the appliance
 
      
 
     
 
     [bookmark: pgfId-8398565]Step 5 Click Save.
 
     [bookmark: pgfId-8446946]Remote console configuration for the appliance is saved. If you configured Lights-Out Management, you must enable it for at least one user; see Enabling Lights-Out Management User Access.
 
     [bookmark: pgfId-8550182]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8369118][bookmark: 46370]Enabling [bookmark: marker-8455514]Lights-Out Management User Access
 
     [bookmark: pgfId-8388485]License: Any
 
     [bookmark: pgfId-8472108]Supported Devices: Series 3
 
     [bookmark: pgfId-8472127]Supported Defense Centers: Series 3
 
     [bookmark: pgfId-8475351]You must explicitly grant Lights-Out Management permissions to users who will use the feature. You configure LOM and LOM users on a per-appliance basis using each appliance’s local web interface. That is, you cannot use the Defense Center to configure LOM on a managed device. Similarly, because users are managed independently per appliance, enabling or creating a LOM-enabled user on the Defense Center does not transfer that capability to users on managed devices.
 
     [bookmark: pgfId-8475317]LOM users also have the following restrictions:
 
      
      	 [bookmark: pgfId-8475318]You must assign the Administrator role to the user.
 
      	 [bookmark: pgfId-8475319]The username may have up to 16 alphanumeric characters. Hyphens and longer user names are not supported for LOM users.
 
      	 [bookmark: pgfId-8660268]The password may have up to 20 alphanumeric characters, except for 3D7100 Family devices. If LOM is enabled on a 3D7110, 3D7115, 3D7120, or 3D7125 device, the password may have up to 16 alphanumeric characters. Passwords longer than 20 or 16 characters, respectively, are not supported for LOM users. A user’s LOM password is the same as that user’s system password. Cisco recommends that you use a complex, non-dictionary-based password of the maximum supported length for your appliance and change it every three months.
 
      	 [bookmark: pgfId-8475330]Series 3 Defense Centers and 8000 Series devices can have up to 13 LOM users. 7000 Series devices can have up to eight LOM users.
 
     
 
     [bookmark: pgfId-8373123]Note that if you deactivate, then reactivate, a role with LOM while a user with that role is logged in, or restore a user or user role from a backup during that user’s login session, that user must log back into the web interface to regain access to IPMItool commands. For more information, see Managing Predefined User Roles.
 
     [bookmark: pgfId-8369125]To enable or view Lights-Out Management user access:
 
     [bookmark: pgfId-8369126]Access: Admin
 
     
 
     [bookmark: pgfId-8369127]Step 1 Select System > Local > User Management.
 
     [bookmark: pgfId-8369128]The User Management page appears.
 
     [bookmark: pgfId-8369133]Step 2 You have the following options:
 
      
       
       	 [bookmark: pgfId-8369134]To grant LOM user access to an existing user, click the edit icon (
 
      
 
      [image: ] ) next to a user name in the list. 
     
 
      
       
       	 [bookmark: pgfId-8369135]To grant LOM user access to a new user, click  Create User .
 
      
 
     
 
     [bookmark: pgfId-8369136]Step 3 Under User Configuration, enable the Administrator role.
 
     [bookmark: pgfId-8369137]Administrator Options appear.
 
     [bookmark: pgfId-8369142]Step 4 Select the Allow Lights-Out Management Access check box.
 
     [bookmark: pgfId-8369143]Step 5 Click Save.
 
     [bookmark: pgfId-8369144]The user has LOM access for this appliance.
 
     [bookmark: pgfId-8550206]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8444930][bookmark: 80093]Using a Serial[bookmark: marker-8455509] Over LAN Connection
 
     [bookmark: pgfId-8444931]License: Any
 
     [bookmark: pgfId-8472157]Supported Devices: Series 3
 
     [bookmark: pgfId-8472161]Supported Defense Centers: Series 3
 
     [bookmark: pgfId-8444932]You use a third-party IPMI utility on your computer to create a Serial Over LAN connection to the appliance. If your computer uses a Linux-like or Mac environment, use IPMItool; for Windows environments, use IPMIutil. 
 
      
       
     
 
     
 
     [bookmark: pgfId-8485004]Note Cisco recommends using IPMItool version 1.8.12 or greater.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8444933]Linux
 
     [bookmark: pgfId-8444934]IPMItool is standard with many distributions and is ready to use.
 
     [bookmark: pgfId-8444935]Mac
 
     [bookmark: pgfId-8444936]You must install IPMItool on a Mac. First, confirm that your Mac has Apple's XCode Developer tools installed, making sure that the optional components for command line development are installed (UNIX Development and System Tools in newer versions, or Command Line Support in older versions). Then you can install macports and the IPMItool. Use your favorite search engine for more information or try these sites:
 
      
      [bookmark: pgfId-8444937] https://developer.apple.com/technologies/tools/ 
     
 
      
      [bookmark: pgfId-8444938] http://www.macports.org/ 
     
 
     [bookmark: pgfId-8444939]Windows
 
     [bookmark: pgfId-8444940]You must compile IPMIutil on Windows. If you do not have access to a compiler, you can use IPMIutil itself to compile. Use your favorite search engine for more information or try this site:
 
      
      [bookmark: pgfId-8444941] http://ipmiutil.sourceforge.net/ 
     
 
     [bookmark: pgfId-8444943][bookmark: 77143]Understanding IPMI Utility Commands
 
     [bookmark: pgfId-8444944]Commands used for IPMI utilities are composed of segments as in the following IPMItool example:
 
      
      [bookmark: pgfId-8444945]ipmitool -I lanplus -H IP_address -U user_name command 
     
 
     [bookmark: pgfId-8444946]where:
 
     [bookmark: pgfId-8444947] – ipmitool invokes the utility
 
     [bookmark: pgfId-8444948] – -I lanplus enables encryption for the session
 
     [bookmark: pgfId-8444949] – -H IP_address indicates the IP address of the appliance you want to access
 
     [bookmark: pgfId-8444950] – -U user_name is the name of an authorized user
 
     [bookmark: pgfId-8444951] – -command is the name of the command you want to give
 
      
       
     
 
     
 
     [bookmark: pgfId-8485022]Note Cisco recommends using IPMItool version 1.8.12 or greater.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8485015]The same command for Windows looks like this:
 
      
      [bookmark: pgfId-8444953]ipmiutil command -V 4 -J 3 -N IP_address -U user_name  
     
 
     [bookmark: pgfId-8444954]This command connects you to the command line on the appliance where you can log in as if you were physically present at the appliance. You may be prompted to enter a password. 
 
     [bookmark: pgfId-8475940]To create a Serial Over LAN connection:
 
     [bookmark: pgfId-8475941]Access: Admin with LOM access
 
     
 
     [bookmark: pgfId-8475942]Step 1 Enter the following command:
 
     [bookmark: pgfId-8445156]For IPMItool:
 
      
      [bookmark: pgfId-8445157]ipmitool -I lanplus -H IP_address -U user_name sol activate 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8485112]Note Cisco recommends using IPMItool version 1.8.12 or greater.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8485113]For IPMIutil:
 
      
      [bookmark: pgfId-8485114]ipmiutil -J 3 -H IP_address -U username sol -a 
     
 
     [bookmark: pgfId-8445160]The command line login for the appliance appears. You may be prompted to enter a password.
 
     [bookmark: pgfId-8550229]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8444956][bookmark: 28925]Using [bookmark: marker-8455519]Lights-Out Management
 
     [bookmark: pgfId-8444957]License: Any
 
     [bookmark: pgfId-8472176]Supported Devices: Series 3
 
     [bookmark: pgfId-8472180]Supported Defense Centers: Series 3
 
     [bookmark: pgfId-8446138]Lights-Out Management provides the ability to perform a limited set of actions over an SOL connection on the default (eth0) management interface without the need to log into the appliance. You use the command to create a SOL connection followed by one of the commands listed in the following table. After the command is completed, the connection ends. Note that not all power control commands are valid on 70xx Family devices. 
 
      
       
     
 
     
 
     [bookmark: pgfId-8670140]Note The baseboard management controller (BMC) for a 3D71xx, 3D82xx, or a 3D83xx device is only accessible via 1Gbps link speeds when the host is powered on. When the device is powered down the BMC can only establish Ethernet link at 10 and 100Mbps. Therefore if LOM is being used to remotely power the device, connect the device to the network using 10 and 100Mbps link speeds only.
 
      
      
 
     
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8456156] 
      Caution In rare cases, if your computer is on a different subnet than the appliance's management interface and the appliance is configured for DHCP, attempting to access LOM features on a Series 3 appliance can fail. If this occurs, you can either disable and then re-enable LOM on the appliance, or use a computer on the same subnet as the appliance to ping its management interface. You should then be able to use LOM. 
       
       
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8660273] 
      Caution Cisco is aware of a vulnerability inherent in the Intelligent Platform Management Interface (IPMI) standard (CVE-2013-4786). Enabling Lights-Out Management (LOM) on an appliance exposes this vulnerability. To mitigate this vulnerability, deploy your appliances on a secure management network accessible only to trusted users and use a complex, non-dictionary-based password of the maximum supported length for your appliance and change it every three months. To prevent exposure to this vulnerability, do not enable LOM. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8657783]If all attempts to access your appliance have failed, you can use LOM to restart your appliance remotely. Note that if a system is restarted while the SOL connection is active, the LOM session may disconnect or time out.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8446429] 
      Caution Do 
      not restart your appliance unless it does not respond to any other attempts to restart. Remotely restarting the appliance does not gracefully reboot the system and you may lose data. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8446354].
 
      
       
        
        [bookmark: pgfId-8475760]Table 64-7 [bookmark: 60067]Lights-Out Management Commands 
 
        
        
         
         	 
           
           [bookmark: pgfId-8475766]IPMItool 
          
  
         	 
           
           [bookmark: pgfId-8475768]IPMIutil 
          
  
         	 
           
           [bookmark: pgfId-8475770]Description 
          
  
        
 
         
         	[bookmark: pgfId-8475772](not applicable)
  
         	[bookmark: pgfId-8475774]-V 4
  
         	[bookmark: pgfId-8475776]Enables admin privileges for the IPMI session
  
        
 
         
         	[bookmark: pgfId-8475778]-I lanplus
  
         	[bookmark: pgfId-8475780]-J 3
  
         	[bookmark: pgfId-8475782]Enables encryption for the IPMI session
  
        
 
         
         	[bookmark: pgfId-8475784]-H
  
         	[bookmark: pgfId-8475786]-N
  
         	[bookmark: pgfId-8475788]Indicates the IP address of the remote appliance
  
        
 
         
         	[bookmark: pgfId-8475790]-U
  
         	[bookmark: pgfId-8475792]-U
  
         	[bookmark: pgfId-8475794]Indicates the username of an authorized LOM account
  
        
 
         
         	[bookmark: pgfId-8475796]sol activate
  
         	[bookmark: pgfId-8475798]sol -a
  
         	[bookmark: pgfId-8475800]Starts the SOL session
  
        
 
         
         	[bookmark: pgfId-8475802]sol deactivate
  
         	[bookmark: pgfId-8475804]sol -d
  
         	[bookmark: pgfId-8475806]Ends the SOL session
  
        
 
         
         	[bookmark: pgfId-8475808]chassis power cycle
  
         	[bookmark: pgfId-8475810]power -c
  
         	[bookmark: pgfId-8475812]Restarts the appliance (not valid on 70xx Family devices)
  
        
 
         
         	[bookmark: pgfId-8475814]chassis power on
  
         	[bookmark: pgfId-8475816]power -u
  
         	[bookmark: pgfId-8475818]Powers up the appliance
  
        
 
         
         	[bookmark: pgfId-8475820]chassis power off
  
         	[bookmark: pgfId-8475822]power -d
  
         	[bookmark: pgfId-8475824]Powers down the appliance (not valid on 
70xx Family devices)
  
        
 
         
         	[bookmark: pgfId-8475826]sdr
  
         	[bookmark: pgfId-8475828]sensor
  
         	[bookmark: pgfId-8475830]Displays appliance information, such as fan speeds and temperatures
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8445053]For example, to display a list of appliance information, the IPMItool command is:
 
      
      [bookmark: pgfId-8445054]ipmitool -I lanplus -H IP_address -U user_name sdr 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8485131]Note Cisco recommends using IPMItool version 1.8.12 or greater.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8445055]The same command with the IPMIutil utility is:
 
      
      [bookmark: pgfId-8445056]ipmiutil sensor -V 4 -J 3 -N IP_address -U user_name  
     
 
     [bookmark: pgfId-8445194]To use Lights-Out Management:
 
     [bookmark: pgfId-8445195]Access: Admin with LOM access
 
     
 
     [bookmark: pgfId-8445196]Step 1 Enter the following command:
 
     [bookmark: pgfId-8445197]For IPMItool:
 
      
      [bookmark: pgfId-8445198]ipmitool -I lanplus -H IP_address -U user_name command 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8485160]Note Cisco recommends using IPMItool version 1.8.12 or greater.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8445199]For IPMIutil:
 
      
      [bookmark: pgfId-8445200]ipmiutil -J 3 -H IP_address -U username command 
     
 
     [bookmark: pgfId-8445203]where command is one of the commands from the Lights-Out Management Commands table.
 
     [bookmark: pgfId-8445205]The corresponding action as noted in the table is performed. You may be prompted to enter a password.
 
     [bookmark: pgfId-8678738]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-8678742][bookmark: 27938]Enabling Clo[bookmark: marker-8678740]ud Communications
 
    [bookmark: pgfId-8678752]License: URL Filtering or Malware
 
    [bookmark: pgfId-8471251]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-8429081]The FireSIGHT System contacts Cisco’s Collective Security Intelligence Cloud to obtain various types of information:
 
     
     	 [bookmark: pgfId-8435105]If your organization has a FireAMP subscription, you can receive endpoint-based malware events; see Working with Cloud Connections for FireAMP. 
 
     	 [bookmark: pgfId-8435295]File policies associated with access control rules allow managed devices to detect files transmitted in network traffic. The Defense Center uses data from the Cisco cloud to determine if the files represent malware; see Understanding and Creating File Policies.
 
     	 [bookmark: pgfId-8435444]When you enable URL filtering, the Defense Center can retrieve category and reputation data for many commonly visited URLs, as well as perform lookups for uncategorized URLs. You can then quickly create URL conditions for access control rules; see Performing Reputation-Based URL Blocking.
 
    
 
    [bookmark: pgfId-8665364]For file and malware cloud-based features, you can use a FireAMP Private Cloud instead of the standard cloud connection if your organization requires additional security or wishes to limit outside connections. All file and malware cloud lookups, as well as collection and relaying of event data from FireAMP endpoints, are handled through the private cloud; when the private cloud contacts the public Cisco cloud, it does so through an anonymized proxy connection. Although it does not support dynamic analysis or non-FireAMP cloud features such as Security Intelligence or URL filtering, the private cloud, from a user’s perspective, functions much the same as a standard public cloud connection. For more information on configuring a private cloud, see Working with the FireAMP Private Cloud.
 
    [bookmark: pgfId-8567932]Use the Defense Center’s local configuration to specify the following options:
 
    [bookmark: pgfId-8465638]Enable URL Filtering
 
    [bookmark: pgfId-8465793]You must enable this option to perform category and reputation-based URL filtering.
 
    [bookmark: pgfId-8678757]Due to memory limitations, some device models perform URL filtering with a smaller, less granular, set of categories and reputations. For example, if a parent domain's subsites have different URL categories and reputations, some devices may use the parent site's data for all subsites. These devices include the 7100 Family and the following ASA FirePOWER models: ASA 5506-X, ASA 5506H-X, ASA 5506W-X, ASA 5508-X, ASA 5512-X, ASA 5515-X, ASA 5516-X, and the ASA 5525-X. 
 
    [bookmark: pgfId-8678781]For virtual devices, see the installation guide for information on allocating the correct amount of memory to perform category and reputation-based URL filtering.
 
    [bookmark: pgfId-8465794]Query Cloud for Unknown URL
 
    [bookmark: pgfId-8436664]Allows the system to query the cloud when someone on your monitored network attempts to browse to a URL that is not in the local data set.
 
    [bookmark: pgfId-8436665]If the cloud does not know the category or reputation of a URL, or if the Defense Center cannot contact the cloud, the URL does not match access control rules with category or reputation-based URL conditions. You cannot assign categories or reputations to URLs manually.
 
    [bookmark: pgfId-8436669]Disable this option if you do not want your uncategorized URLs to be cataloged by the Cisco cloud, for example, for privacy reasons.
 
    [bookmark: pgfId-8436670]Enable Automatic Updates
 
    [bookmark: pgfId-8436671]Allows the system to contact the cloud on a regular basis to obtain updates to the URL data in your appliances’ local data sets. Although the cloud typically updates its data once per day, enabling automatic updates forces the Defense Center to check every 30 minutes to make sure that you always have up-to-date information. 
 
    [bookmark: pgfId-8436675]Although daily updates tend to be small, if it has been more than five days since your last update, new URL filtering data may take up to 20 minutes to download, depending on your bandwidth. Then, it may take up to 30 minutes to perform the update itself.
 
    [bookmark: pgfId-8436676]If you want to have strict control of when the system contacts the cloud, you can disable automatic updates and use the scheduler instead, as described in Automating URL Filtering Updates. 
 
     
      
    
 
    
 
    [bookmark: pgfId-8436683]Note Cisco recommends that you either enable automatic updates or use the scheduler to schedule updates. Although you can manually perform on-demand updates, allowing the system to automatically contact the cloud on a regular basis provides you with the most up-to-date, relevant URL data.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8436684]Share URI Information of malware events with Cisco
 
    [bookmark: pgfId-8436685]Optionally, Defense Centers can send information about the files detected in network traffic to the cloud. This information includes URI information associated with detected files and their SHA-256 hash values. Although sharing is opt-in, transmitting this information to Cisco will help with future efforts to identify and track malware.
 
    [bookmark: pgfId-8479677]Use legacy port 32137 for network AMP lookups
 
    [bookmark: pgfId-8480184]Selecting this check box allows your system to use port 32137/tcp (the previous default port) for network cloud lookups instead of port 443/tcp. If you updated your appliances from a previous version of the FireSIGHT System, this check box is selected by default.
 
    [bookmark: pgfId-8374929]Licen[bookmark: licensing]sing
 
    [bookmark: pgfId-8441204]Performing category and reputation-based URL filtering and device-based malware detection require that you enable the appropriate licenses on your managed devices; see Licensing the FireSIGHT System.
 
    [bookmark: pgfId-8441934]You cannot configure cloud connection options if you have no URL Filtering or Malware licenses on the Defense Center. If you have one license but not the other, the Cloud Services local configuration page displays only the options for which you are licensed. Defense Centers with expired licenses cannot contact the cloud.
 
    [bookmark: pgfId-8484517]Note that, in addition to causing the URL Filtering configuration options to appear, adding a URL Filtering license to your Defense Center automatically enables Enable URL Filtering and Enable Automatic Updates. You can manually disable the options if needed.
 
    [bookmark: pgfId-8441944]Note that receiving endpoint-based malware events using a FireAMP subscription does not require a license, nor does specifying individual URLs or groups of URLs to allow or block. For more information, see Understanding Malware Protection and File Control and Performing Manual URL Blocking.
 
    [bookmark: pgfId-8415340]Internet Access and High Availability
 
    [bookmark: pgfId-8632791]The system uses ports 80/HTTP and 443/HTTPS to contact the Cisco cloud and also supports use of a proxy; see Configuring Management Interfaces.
 
    [bookmark: pgfId-8441473]Although all URL filtering configurations and information are synchronized between Defense Centers in a high availability deployment, only the primary Defense Center downloads URL filtering data. If the primary Defense Center fails, you must make sure that the secondary Defense Center has direct access to the Internet and use the web interface on the secondary Defense Center to promote it to Active. For more information, see Monitoring and Changing High Availability Status.
 
    [bookmark: pgfId-8441345]On the other hand, although they share file policies and related configurations, Defense Centers in a high availability pair share neither cloud connections nor malware dispositions. To ensure continuity of operations, and to ensure that detected files’ malware dispositions are the same on both Defense Centers, both primary and secondary Defense Centers must have access to the cloud.
 
    [bookmark: pgfId-8415424]Health Monitoring
 
    [bookmark: pgfId-8415425]The default health policy includes the following modules that track the state and stability of the Defense Center’s cloud connections:
 
    [bookmark: pgfId-8438001] – URL Filtering Monitor, which also warns you if the Defense Center fails to push category and reputation updates to its managed devices
 
    [bookmark: pgfId-8438048] – Advanced Malware Protection
 
     
      
    
 
    
 
    [bookmark: pgfId-8438063]Tip Another module, the FireAMP Status Monitor, tracks the Defense Center’s connection to the Cisco cloud for FireAMP subscription holders. For more information on health monitoring, see Using the Health Monitor.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8428344]The following procedures explain how to enable communications the Cisco cloud, and how to perform an on-demand update of URL data. Note that you cannot start an on-demand update if an update is already in progress.
 
    [bookmark: pgfId-8372172]To enable communications with the cloud:
 
    [bookmark: pgfId-8372173]Access: Admin
 
    
 
    [bookmark: pgfId-8369502]Step 1 Select System > Local > Configuration.
 
    [bookmark: pgfId-8369503]The Information page appears.
 
    [bookmark: pgfId-8428679]Step 2 Click Cloud Services.
 
    [bookmark: pgfId-8428680]The Cloud Services page appears. If you have a URL Filtering license, the page displays the last time URL data was updated.
 
    [bookmark: pgfId-8369429]Step 3 Configure cloud connection options as described above.
 
    [bookmark: pgfId-8428824]You must Enable URL Filtering before you can Enable Automatic Updates or Query Cloud for Unknown URLs.
 
    [bookmark: pgfId-8372036]Step 4 Click Save.
 
    [bookmark: pgfId-8428912]Your settings are saved. If you enabled URL filtering, depending on how long it has been since URL filtering was last enabled, or if this is the first time you enabled URL filtering, the Defense Center retrieves URL filtering data from the cloud.
 
    [bookmark: pgfId-8550288]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8428916]To perform an on-demand update of the system’s URL data:
 
    [bookmark: pgfId-8372076]Access: Admin
 
    
 
    [bookmark: pgfId-8372091]Step 1 Select System > Local > Configuration.
 
    [bookmark: pgfId-8372092]The Information page appears.
 
    [bookmark: pgfId-8372093]Step 2 Click URL Filtering.
 
    [bookmark: pgfId-8372148]The URL Filtering page appears.
 
    [bookmark: pgfId-8372149]Step 3 Click Update Now.
 
    [bookmark: pgfId-8372150]The Defense Center contacts the cloud and updates its URL filtering data if an update is available.
 
    [bookmark: pgfId-8550302]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8632800][bookmark: 80799]Enabling VMware Tools
 
    [bookmark: pgfId-8632804]License: Any
 
    [bookmark: pgfId-8632808]Supported Defense Centers: virtual
 
    [bookmark: pgfId-8632810]VMware Tools is a suite of utilities intended to enhance the performance of the virtual machine. These utilities allow you to make full use of the convenient features of VMware products. The system supports the following plugins on all virtual appliances:
 
     
     	 [bookmark: pgfId-8632811]guestInfo
 
     	 [bookmark: pgfId-8632812]powerOps
 
     	 [bookmark: pgfId-8674021]snapshot
 
     	 [bookmark: pgfId-8632813]timeSync
 
     	 [bookmark: pgfId-8632814]vmbackup
 
    
 
    [bookmark: pgfId-8643490]You can also enable VMware To[bookmark: marker-8643489]ols on all supported ESXi versions. For a list of supported versions, see the FireSIGHT System Virtual Installation Guide. For information on the full functionality of VMware Tools, see the VMware website (http://www.vmware.com/).
 
    [bookmark: pgfId-8632838]The following procedure describes how to enable VMware Tools on the virtual Defense Center using the Configuration menu on the web interface. Because the virtual device does not have a web interface, you must use the command line interface to enable VMware Tools on a virtual device; see the FireSIGHT System Virtual Installation Guide.
 
    [bookmark: pgfId-8642357]To enable VMware Tools on a virtual Defense Center:
 
    [bookmark: pgfId-8642361]Access: Admin
 
    
 
    [bookmark: pgfId-8642362]Step 1 Select System > Local > Configuration.
 
    [bookmark: pgfId-8642363]The Information page appears.
 
    [bookmark: pgfId-8642364]Step 2 Click VMware Tools.
 
    [bookmark: pgfId-8642365]The VMware Tools page appears.
 
    [bookmark: pgfId-8642527]Step 3 Click Enable VMware Tools and click Save.
 
    [bookmark: pgfId-8642531]Your changes are saved.
 
    [bookmark: pgfId-8642532]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8389641]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7707274][bookmark: 75906]Licensing the FireSIGHT System 
      
      
 
     
 
 
    [bookmark: pgfId-8344469]You can license a variety of features to create an optimal FireSIGHT System deployment for your organization. You use the Defense Center to manage licenses for itself and the devices it manages.
 
    [bookmark: pgfId-8342533]For more information, see:
 
     
     	 [bookmark: pgfId-8345123]Understanding Licensing
 
     	 [bookmark: pgfId-8358208]Viewing Your Licenses
 
     	 [bookmark: pgfId-8358235]Adding a License to the Defense Center
 
     	 [bookmark: pgfId-8358267]Deleting a License
 
     	 [bookmark: pgfId-8374357]Changing a Device’s Licensed Capabilities
 
    
 
   
 
    
     [bookmark: pgfId-8374361][bookmark: 98698]Understanding[bookmark: marker-8374359] Licensing
 
    [bookmark: pgfId-8322151]License: Any
 
    [bookmark: pgfId-8439978]You can license a variety of features to create an optimal FireSIGHT System deployment for your organization. A FireSIGHT license is included with your Defense Center and is required to perform host, application, and user discovery. 
 
    [bookmark: pgfId-8439985]Additional model-specific licenses allow your managed devices to perform a variety of functions including:
 
     
     	 [bookmark: pgfId-8422488]intrusion detection and prevention
 
     	 [bookmark: pgfId-8422503]Security Intelligence filtering
 
     	 [bookmark: pgfId-8422510]file control and advanced malware protection
 
     	 [bookmark: pgfId-8425466]application, user, and URL control
 
     	 [bookmark: pgfId-8422524]switching and routing
 
     	 [bookmark: pgfId-8427799]device clustering
 
     	 [bookmark: pgfId-8427449]network address translation (NAT)
 
     	 [bookmark: pgfId-8427430]virtual private network (VPN) deployments
 
    
 
    [bookmark: pgfId-8407931]There are a few ways you may lose access to licensed features in the FireSIGHT System. You can remove licenses from the Defense Center, which affects all of its managed devices. You can also disable licensed capabilities on specific managed devices. Finally, some licenses may expire. Though there are some exceptions, you cannot use the features associated with an expired or deleted license.
 
    [bookmark: pgfId-8479023]Certain licenses, like the FireSIGHT license, are perpetual. Other licenses require that you purchase a service subscription to enable the license.
 
    [bookmark: pgfId-8479853]For more information, see:
 
     
     	 [bookmark: pgfId-8479857]License Types and Restrictions
 
     	 [bookmark: pgfId-8479867]Service Subscriptions
 
     	 [bookmark: pgfId-8479861]Licensing High Availability Pairs
 
     	 [bookmark: pgfId-8377704]Licensing Stacked and Clustered Devices
 
     	 [bookmark: pgfId-8477688]Licensing Series 2 Appliances
 
     	 [bookmark: pgfId-8479399]Understanding FireSIGHT Host and User License Limits
 
    
 
     
      [bookmark: pgfId-8479443][bookmark: 85702]License[bookmark: marker-8479442] Types and Restrictions
 
     [bookmark: pgfId-8477711]License: Any
 
     [bookmark: pgfId-8448300]This section describes the types of licenses available in a FireSIGHT System deployment. The licenses you can enable on an appliance depend on its model, version, and (for managed devices) the other licenses enabled.
 
     [bookmark: pgfId-8419960]For virtual and Series 3 devices, licenses are model specific; you cannot enable a license on a managed device unless the license exactly matches the device’s model. For example, you cannot use a 3D8250 Protection license to enable Protection capabilities on a 3D8140 device. As your organization and deployment grow, you can purchase additional licenses for additional managed devices.
 
     [bookmark: pgfId-8419973]Series 2 devices automatically have Protection capabilities (with the exception of Security Intelligence filtering). Although you do not need to explicitly enable Protection on Series 2 devices, you also cannot enable any other licenses.
 
     [bookmark: pgfId-8413557]Also note that although you can enable Control on a virtual device or ASA FirePOWER device to perform user and application control, these devices do not support switching, routing, stacking, or clustering. 
 
     [bookmark: pgfId-8412692]The following table summarizes FireSIGHT System licenses.
 
     [bookmark: pgfId-8410547]
 
      
       
        
        [bookmark: pgfId-8477010]Table 65-1 [bookmark: 72441]FireSIGHT System Licenses 
 
        
        
         
         	 
           
           [bookmark: pgfId-8477022]License You Assign in FireSIGHT System 
          
  
         	 
           
           [bookmark: pgfId-8477024]Service Subscription You Purchase 
          
  
         	 
           
           [bookmark: pgfId-8477026]Platforms 
          
  
         	 
           
           [bookmark: pgfId-8477028]Granted Capabilities 
          
  
         	 
           
           [bookmark: pgfId-8477030]Requires 
          
  
         	 
           
           [bookmark: pgfId-8477032]Expire Capable? 
          
  
        
 
         
         	[bookmark: pgfId-8477037]FireSIGHT
  
         	[bookmark: pgfId-8477039]none
  
         	[bookmark: pgfId-8477044]Defense Centers
  
         	[bookmark: pgfId-8477046]discovery
  
         	[bookmark: pgfId-8477048]none
  
         	[bookmark: pgfId-8477050]no
  
        
 
         
         	[bookmark: pgfId-8477055]Protection
(licensed)
  
         	[bookmark: pgfId-8477057]TA (included with device)
  
         	[bookmark: pgfId-8477065]Series 3, Virtual, X-Series, ASA FirePOWER
  
         	[bookmark: pgfId-8477070]intrusion detection and prevention
 [bookmark: pgfId-8477071]file control
 [bookmark: pgfId-8477072]Security Intelligence filtering
  
         	[bookmark: pgfId-8477074]none
  
         	[bookmark: pgfId-8477076]no
  
        
 
         
         	[bookmark: pgfId-8477081]Protection (automatic)
  
         	[bookmark: pgfId-8477083]none (included with device)
  
         	[bookmark: pgfId-8477088]Series 2
  
         	[bookmark: pgfId-8477090]intrusion detection and prevention
 [bookmark: pgfId-8477091]file control
  
         	[bookmark: pgfId-8477093]none
  
         	[bookmark: pgfId-8477095]no
  
        
 
         
         	[bookmark: pgfId-8477100]Control
  
         	[bookmark: pgfId-8477102]none (included with device)
  
         	[bookmark: pgfId-8477107]Virtual, ASA FirePOWER
  
         	[bookmark: pgfId-8477109]user and application control
  
         	[bookmark: pgfId-8477114]Protection
  
         	[bookmark: pgfId-8477116]no
  
        
 
         
         	[bookmark: pgfId-8477121]Control
  
         	[bookmark: pgfId-8477123]none (included with device)
  
         	[bookmark: pgfId-8477128]Series 3
  
         	[bookmark: pgfId-8477130]user and application control
 [bookmark: pgfId-8477131]switching and routing
 [bookmark: pgfId-8477132]clustering
  
         	[bookmark: pgfId-8477137]Protection
  
         	[bookmark: pgfId-8477139]no
  
        
 
         
         	[bookmark: pgfId-8477144]Malware
  
         	[bookmark: pgfId-8477146]TAM, TAMC, or AMP
  
         	[bookmark: pgfId-8477151]Series 3, Virtual, ASA FirePOWER
  
         	[bookmark: pgfId-8477156]advanced malware protection (network-based malware detection and blocking)
  
         	[bookmark: pgfId-8477161]Protection
  
         	[bookmark: pgfId-8477163]yes
  
        
 
         
         	[bookmark: pgfId-8477168]URL Filtering
  
         	[bookmark: pgfId-8477170]TAC, TAMC, or URL
  
         	[bookmark: pgfId-8477178]Series 3, Virtual, X-Series, ASA FirePOWER
  
         	[bookmark: pgfId-8477183]category and reputation-based URL filtering
  
         	[bookmark: pgfId-8477188]Protection
  
         	[bookmark: pgfId-8477190]yes
  
        
 
         
         	[bookmark: pgfId-8477195]VPN
  
         	[bookmark: pgfId-8477197]none (contact Sales for more information)
  
         	[bookmark: pgfId-8477202]Series 3
  
         	[bookmark: pgfId-8477204]deploying virtual private networks
  
         	[bookmark: pgfId-8477209]Control
  
         	[bookmark: pgfId-8477211]yes
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8410548]Note that the DC500 Defense Center does not support the capabilities provided by a URL Filtering or Malware license.
 
     [bookmark: pgfId-8438506]For more information, see:
 
      
      	 [bookmark: pgfId-8410552]FireSIGHT
 
      	 [bookmark: pgfId-8408724]Protection
 
      	 [bookmark: pgfId-8408744]Control
 
      	 [bookmark: pgfId-8408764]Malware
 
      	 [bookmark: pgfId-8408788]URL Filtering
 
      	 [bookmark: pgfId-8408857]VPN
 
     
 
    
 
     
      [bookmark: pgfId-8408530][bookmark: 87196]FireSIGHT
 
     [bookmark: pgfId-8408534]License: FireSIGHT
 
     [bookmark: pgfId-8439969]A FireSIGHT lice[bookmark: marker-8439965]nse is included with your Defense Center and allows you to perform host, application, and user discovery. Discovery data allows the system to create a complete, up-to-the-minute profile of your network, and correlate threat, endpoint, and network intelligence with user identity information. You can use discovery data to perform traffic profiling, assess network compliance, and implement correlation policies.
 
     [bookmark: pgfId-8439956]Your FireSIGHT license also determines how many individual hosts and users you can monitor with the Defense Center and its managed devices. Note that the user limit applies independently to the following:
 
      
      	 [bookmark: pgfId-8364884]the Users database, which contains a record for each user detected by the FireSIGHT System
 
      	 [bookmark: pgfId-8364968]the number of users you can use in access control rules to perform user control, also called  access-controlled users 
 
     
 
     [bookmark: pgfId-8365013]For information on the consequences of reaching the licensed limit, see Understanding FireSIGHT Host and User License Limits.
 
     [bookmark: pgfId-8364937]Without a FireSIGHT license, you can still perform basic system configuration, monitoring, network-based access control (zone, network, VLAN, and port rule conditions), connection logging, and reporting. Additionally, you can receive endpoint-based malware events from the Collective Security Intelligence Cloud without a FireSIGHT license, although your organization does need a FireAMP subscription.
 
      
       
     
 
     
 
     [bookmark: pgfId-8439930]Tip The License statements in this guide assume your Defense Center has a FireSIGHT license. However, if the Defense Center was previously running Version 4.10.x, you may be able to use legacy RNA Host and RUA User licenses instead of a FireSIGHT license. For more information, see Protection.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8362667][bookmark: 84072][bookmark: 21372]Protection
 
     [bookmark: pgfId-8450444]License: Protection
 
     [bookmark: pgfId-8450454]Supported Devices: Series 3, Virtual, X-Series, ASA FirePOWER
 
     [bookmark: pgfId-8462022]A Protection lice[bookmark: marker-8462021]nse allows you to perform intrusion detection and prevention, file control, and Security Intelligence filtering:
 
      
      	 [bookmark: pgfId-8462023] Intrusion detection and prevention allows you to analyze network traffic for intrusions and exploits and, optionally, drop offending packets.
 
      	 [bookmark: pgfId-8419740] File control allows you to detect and, optionally, block users from uploading (sending) or downloading (receiving) files of specific types over specific application protocols. With a Malware license (see Malware), you can also inspect and block a restricted set of those file types based on their malware dispositions.
 
      	 [bookmark: pgfId-8479948] Security Intelligence filtering allows you to blacklist—deny traffic to and from—specific IP addresses, before the traffic is subjected to analysis by access control rules. Dynamic feeds allow you to immediately blacklist connections based on the latest intelligence. Optionally, you can use a “monitor-only” setting for Security Intelligence filtering.
 
     
 
     [bookmark: pgfId-8479949]A Protection license (along with a Control license) is automatically included in the purchase of any managed device. This license is perpetual, but you must also purchase a TA subscription to enable system updates.
 
     [bookmark: pgfId-8479953]Although you can configure an access control policy to perform Protection-related inspection without a license, you cannot apply the policy until you first add a Protection license to the Defense Center, then enable it on the devices targeted by the policy.
 
     [bookmark: pgfId-8419178]If you delete your Protection license from the Defense Center or disable Protection on managed devices, the Defense Center stops acknowledging intrusion and file events from the affected devices. As a consequence, correlation rules that use those events as a trigger criteria stop firing. Additionally, the Defense Center will not contact the internet for either Cisco-provided or third-party Security Intelligence information. You cannot reapply existing policies until you re-enable Protection.
 
     [bookmark: pgfId-8423378]Because a Protection license is required for URL Filtering, Malware, and Control licenses, deleting or disabling a Protection license has the same effect as deleting or disabling your URL Filtering, Malware, or Control license.
 
      
       
     
 
     
 
     [bookmark: pgfId-8423394]Note Series 2 devices automatically have most Protection capabilities; you do not have to purchase or enable Protection licenses for these devices. However, Series 2 devices cannot perform Security Intelligence filtering.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8388117][bookmark: 36712][bookmark: 97657]Control
 
     [bookmark: pgfId-8388121]License: Control
 
     [bookmark: pgfId-8450615]Supported Devices: Series 3, Virtual, ASA FirePOWER
 
     [bookmark: pgfId-8450622]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-8472007]A Control licen[bookmark: marker-8472006]se allows you to implement user and application control by adding user and application conditions to access control rules. It also allows you to configure your Series 3 managed devices to perform switching and routing (including DHCP relay and NAT), as well as cluster managed devices. To enable Control on a managed device, you must also enable Protection.
 
      
       
     
 
     
 
     [bookmark: pgfId-8472023]Note Although you can enable a Control license on a virtual device or ASA FirePOWER device, these devices do not support switching, routing, stacking, or clustering.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8368944]A Control license is automatically included (along with a Protection license) in the purchase of any managed device. This license is perpetual, but you must also purchase a TA subscription to enable system updates.
 
     [bookmark: pgfId-8480116]Although you can add user and application conditions to access control rules without a Control license, you cannot apply the policy until you first add a Control license to the Defense Center, then enable it on the devices targeted by the policy.
 
     [bookmark: pgfId-8438950]Note that the DC500 Defense Center does not support adding user conditions in access control rules.
 
     [bookmark: pgfId-8373901]Without a Control license, you cannot create switched, routed, or hybrid interfaces on your managed devices; create NAT entries; or configure DHCP relay for virtual routers. Although you can create virtual switches and routers, they are not useful without switched and routed interfaces to populate them. Further, you cannot apply a device configuration that includes switching or routing to a managed device where you have not enabled Control. Additionally, establishing clustering between managed devices requires that the devices are enabled for Control.
 
     [bookmark: pgfId-8373917]If you delete your Control license from the Defense Center or disable Control on individual devices, the affected devices do not stop performing switching or routing, nor do device clusters break. Although you can edit and delete existing configurations, you cannot apply your changes to the affected devices. You cannot add new switched, routed, or hybrid interfaces, nor can you add new NAT entries, configure DHCP relay, or establish device clustering. Finally, you cannot reapply existing access control policies if they include rules with user or application conditions.
 
    
 
     
      [bookmark: pgfId-8362872][bookmark: 44381]URL Filtering
 
     [bookmark: pgfId-8362886]License: URL Filtering
 
     [bookmark: pgfId-8417003]Supported Devices: Series 3, Virtual, X-Series, ASA FirePOWER
 
     [bookmark: pgfId-8426934]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-8448446]URL filtering allo[bookmark: marker-8439653]ws you to write access control rules that determine the traffic that can traverse your network based on URLs requested by monitored hosts, correlated with information about those URLs, which is obtained from the Cisco cloud by the Defense Center. To enable URL Filtering, you must also enable a Protection license.
 
      
       
     
 
     
 
     [bookmark: pgfId-8480209]Tip Without a URL Filtering license, you can specify individual URLs or groups of URLs to allow or block. This gives you granular, custom control over web traffic, but does not allow you to use URL category and reputation data to filter network traffic.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8480298]You can purchase a URL Filtering license as a services subscription combined with Threat & Apps (TAC) or Threat & Apps and Malware (TAMC), or as an add-on subscription (URL) for a system where Threat & Apps (TA) is already enabled.
 
     [bookmark: pgfId-8480214]Although you can add category and reputation-based URL conditions to access control rules without a URL Filtering license, the Defense Center will not contact the cloud for URL information. You cannot apply the access control policy until you first add a URL Filtering license to the Defense Center, then enable it on the devices targeted by the policy.
 
     [bookmark: pgfId-8374618]You may lose access to URL filtering if you delete the license from the Defense Center or disable URL Filtering on managed devices. Also, URL Filtering licenses may expire. If your license expires or if you delete or disable it, access control rules with URL conditions immediately stop filtering URLs, and your Defense Center can no longer contact the cloud. You cannot reapply existing access control policies if they include rules with category and reputation-based URL conditions.
 
    
 
     
      [bookmark: pgfId-8384352][bookmark: 88923]Malware
 
     [bookmark: pgfId-8384353]License: Malware
 
     [bookmark: pgfId-8417022]Supported Devices: Series 3, Virtual, ASA FirePOWER
 
     [bookmark: pgfId-8427015]Supported Defense Centers: Any except DC500
 
     [bookmark: pgfId-8448499]A Malware licen[bookmark: marker-8394496]se allows you to perform advanced malware protection, that is, use managed devices to detect and block malware in files transmitted over your network. To enable Malware on a managed device, you must also enable Protection.
 
      
       
     
 
     
 
     [bookmark: pgfId-8470001]Note Managed devices with Malware licenses enabled periodically attempt to connect to the Cisco cloud even if you have not configured dynamic analysis. Because of this, the device’s Interface Traffic dashboard widget shows transmitted traffic; this is expected behavior.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8480390]You configure malware detection as part of a file policy, which you then associate with one or more access control rules. File policies can detect your users uploading or downloading files of specific types over specific application protocols. The Malware license allows you to inspect a restricted set of those file types for malware, as well as download and submit specific file types to the Cisco cloud for dynamic and Spero analysis to determine whether they contain malware. The Malware license also allows you add specific files to a file list and enable the file list within a file policy, allowing those files to be automatically allowed or blocked on detection.
 
     [bookmark: pgfId-8480400]You can purchase a Malware license as a subscription combined with Threat &Apps (TAM) or Threat & Apps and URL Filtering (TAMC), or as an add-on subscription (AMP) for a system where Threat & Apps (TA) is already enabled.
 add a Malware license, then enable it on the devices targeted by the policy. If you later disable the license on the devices, you cannot reapply an existing access control policy to those devices if it includes file policies that perform malware detection. 
     
 
     [bookmark: pgfId-8426745]If you delete all your Malware licenses or they all expire, the Defense Center stops performing malware cloud lookups, and also stops acknowledging retrospective events sent from the Cisco cloud. You cannot reapply existing access control policies if they include file policies that perform malware detection. Note that for a very brief time after a Malware license expires or is deleted, the system can use cached dispositions for files detected by Malware Cloud Lookup file rules. After the time window expires, the system assigns a disposition of Unavailable to those files, rather than performing a lookup.
 
     [bookmark: pgfId-8426755]Note that a Malware license is only required if you want the system to detect malware in network traffic. Without a Malware license, the Defense Center can receive endpoint-based malware events from the Cisco cloud if your organization has a FireAMP subscription. For more information, see Understanding Malware Protection and File Control.
 
    
 
     
      [bookmark: pgfId-8402884][bookmark: 19801]VPN
 
     [bookmark: pgfId-8402937]License: VPN
 
     [bookmark: pgfId-8422200]Supported Devices: Series 3
 
     [bookmark: pgfId-8427646]VPN allows you to establish secure tunnels between endpoints via a public source, such as the Internet or other network. You can configure the FireSIGHT System to build secure VPN tunnels between the virtual routers of Cisco managed devices. To enable VPN, you must also enable Protection and Control licenses. To purchase a VPN license, contact Sales.
 
     [bookmark: pgfId-8428264]Without a VPN license, you cannot configure a VPN deployment with your managed devices. Although you can create deployments, they are not useful without at least one VPN-enabled routed interface to populate them.
 
     [bookmark: pgfId-8427782]If you delete your VPN license from the Defense Center or disable VPN on individual devices, the affected devices do not break the current VPN deployments. Although you can edit and delete existing deployments, you cannot apply your changes to the affected devices.
 
    
 
     
      [bookmark: pgfId-8479702][bookmark: 47822]Service Subscriptions
 
     [bookmark: pgfId-8479706]License: Any
 
     [bookmark: pgfId-8479707]A service subscription enables specific features on a managed device for a set length of time. Service subscriptions can be purchased in one-, three-, or five-year terms. If a subscription expires, Cisco notifies you that you must renew the subscription. If a subscription expires, you might not be able to use the related features, depending on the feature type.
 
     [bookmark: pgfId-8479708]Your purchase of a managed device automatically includes Control and Protection licenses. These licenses are perpetual, but you must also purchase a TA service subscription to enable system updates. Additional service subscriptions are optional.
 
     [bookmark: pgfId-8479709]Service subscriptions correspond to the licenses you assign to managed devices in the FireSIGHT System, as follows:
 
      
       
        
        [bookmark: pgfId-8479712]Table 65-2 FireSIGHT Service Subscriptions
 
        
        
         
         	 
           
           [bookmark: pgfId-8479716]Subscription You Purchase 
          
  
         	 
           
           [bookmark: pgfId-8479718]License You Assign in FireSIGHT System 
          
  
        
 
         
         	[bookmark: pgfId-8479720]TA
  
         	[bookmark: pgfId-8479722]Control + Protection (a.k.a. "Threat & Apps," required for system updates) 
  
        
 
         
         	[bookmark: pgfId-8479724]TAC
  
         	[bookmark: pgfId-8479726]Control + Protection + URL Filtering
  
        
 
         
         	[bookmark: pgfId-8479728]TAM
  
         	[bookmark: pgfId-8479730]Control + Protection + Malware
  
        
 
         
         	[bookmark: pgfId-8479732]TAMC
  
         	[bookmark: pgfId-8479734]Control + Protection + URL Filtering + Malware
  
        
 
         
         	[bookmark: pgfId-8479736]AMP
  
         	[bookmark: pgfId-8479738]Malware (add-on where TA is already present)
  
        
 
         
         	[bookmark: pgfId-8479740]URL
  
         	[bookmark: pgfId-8479742]URL Filtering (add-on where TA is already present)
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-8413370][bookmark: 76600][bookmark: 58828]Licensing High Availability Pairs
 
     [bookmark: pgfId-8388835]License: Any
 
     [bookmark: pgfId-8427214]Supported Defense Centers: DC1000, DC1500, DC2000, DC3000, DC3500, DC4000
 
     [bookmark: pgfId-8356617]Defense Centers in a high availability [bookmark: marker-8356616]pair do not share licenses. You must apply equivalent licenses to each member of the pair. Because Cisco generates licenses based on each Defense Center’s unique license key, you cannot use the same licenses on different Defense Centers.
 
    
 
     
      [bookmark: pgfId-8377781][bookmark: 84228]Licensing Stacked and Clustered Devices
 
     [bookmark: pgfId-8429114]License: Any
 
     [bookmark: pgfId-8429115]Supported Devices: feature dependent
 
     [bookmark: pgfId-8442589]Individual devices must have equivalent licenses before they can be [bookmark: marker-8442588]stacked or clustered. After you stack devices, you can change the licenses for the entire stack. However, you cannot change the enabled licenses on a device cluster.
 
     [bookmark: pgfId-8442590]You can stack 3D8140, 3D8200 family, 3D8300 family, and 3D9900 devices of the same model that meet the requirements described in Managing Stacked Devices. You can cluster two devices of the same Series 3 model that meet the requirements described in Clustering Devices.
 
    
 
     
      [bookmark: pgfId-8402796][bookmark: 12854]Licensing Series 2 Appliances
 
     [bookmark: pgfId-8402853]License: Protection
 
     [bookmark: pgfId-8422232]Supported Devices: Series 2
 
     [bookmark: pgfId-8436106]With the exception of the DC500, Series 2 and Series 3 Defense Center licensing is identical. Because the DC500 does not support URL filtering or network-based malware detection, it cannot take advantage of URL Filtering or Malware licenses.
 
     [bookmark: pgfId-8437400]Series 2 devices automatically have the capabilities, except for Security Intelligence, enabled by a Protection license. You cannot disable the Protection license on Series 2 devices, and you cannot enable other licenses.
 
     [bookmark: pgfId-8437404]See the following sections for more information:
 
      
      	 [bookmark: pgfId-8436460]Service Subscriptions describes the types of licenses available in a FireSIGHT System deployment.
 
      	 [bookmark: pgfId-8439637]Summary of Supported Capabilities by Managed Device Model summarizes supported and unsupported features on Series 2 appliances.
 
     
 
    
 
     
      [bookmark: pgfId-8439646][bookmark: 55836]Understanding FireSIGHT Host and[bookmark: marker-8439645] User License Limits
 
     [bookmark: pgfId-8439650]License: FireSIGHT
 
     [bookmark: pgfId-8439625]The FireSIGHT license on your Defense Center determines how many individual hosts and users you can monitor with the Defense Center and its managed devices, as well as how many users you can use to perform user control. FireSIGHT host and user license limits are model specific, as listed in the following table.
 
     [bookmark: pgfId-8439584]
 
      
       
        
        [bookmark: pgfId-8443636]Table 65-3 FireSIGHT Limits by Defense Center Model 
 
        
        
         
         	 
           
           [bookmark: pgfId-8443643]Defense Center Model 
          
  
         	 
           
           [bookmark: pgfId-8443648]FireSIGHT Host and User Limit 
          
  
        
 
         
         	[bookmark: pgfId-8443650]DC500
  
         	[bookmark: pgfId-8443652]1000
  
        
 
         
         	[bookmark: pgfId-8443654]DC750
  
         	[bookmark: pgfId-8443656]2000
  
        
 
         
         	[bookmark: pgfId-8443658]DC1000
  
         	[bookmark: pgfId-8443660]20,000
  
        
 
         
         	[bookmark: pgfId-8443662]DC1500
  
         	[bookmark: pgfId-8443664]50,000
  
        
 
         
         	[bookmark: pgfId-8463706]DC2000
  
         	[bookmark: pgfId-8463708]100,000
  
        
 
         
         	[bookmark: pgfId-8443666]DC3000
  
         	[bookmark: pgfId-8443668]100,000
  
        
 
         
         	[bookmark: pgfId-8443670]DC3500
  
         	[bookmark: pgfId-8443672]300,000
  
        
 
         
         	[bookmark: pgfId-8463476]DC4000
  
         	[bookmark: pgfId-8463478]600,000
  
        
 
         
         	[bookmark: pgfId-8443674]virtual
  
         	[bookmark: pgfId-8443676]50,000
  
        
 
        
      
 
     
 
     [bookmark: pgfId-8439585]For example, you can monitor 1000 hosts and 1000 users with the DC500.
 
     [bookmark: pgfId-8439591]If your Defense Center was previously running Version 4.10.x of the FireSIGHT System and you used an ISO file to “restore” the appliance to Version 5.x factory defaults, you may be able to use your legacy RNA Host and RUA User licenses instead of a FireSIGHT license.
 
     [bookmark: pgfId-8406100]For more information, see the following sections:
 
      
      	 [bookmark: pgfId-8370954]Understanding the FireSIGHT Host Limit
 
      	 [bookmark: pgfId-8372428]Understanding the FireSIGHT User Limit
 
      	 [bookmark: pgfId-8406108]Understanding the Access-Controlled User Limit
 
      	 [bookmark: pgfId-8439508]Protection
 
     
 
    
 
     
      [bookmark: pgfId-8439513][bookmark: 90771]Understanding the FireSIGHT Host Limit
 
     [bookmark: pgfId-8439517]License: FireSIGHT
 
     [bookmark: pgfId-8440447]The FireSIGHT license on your Defense Center determines how many individual hosts you can monitor with the Defense Center and its managed devices, and therefore how many hosts you can store in your network map. 
 
     [bookmark: pgfId-8440461]Note that the system counts MAC-only hosts separately from hosts identified by both IP addresses and MAC addresses. All IP addresses associated with a host are counted together as one host.
 
     [bookmark: pgfId-8439442]When the system detects activity associated with a host with an IP address in your monitored network (as defined by your network discovery policy), that host is added to the network map.
 
     [bookmark: pgfId-8440456]If you reach the host limit and the system detects a new host, whether the new host is added to the network map depends on the When Host Limit Reached setting in your network discovery policy. You can configure the system either to stop adding new hosts to the database, or to replace the hosts that have remained inactive for the longest time.
 
      
       
     
 
     
 
     [bookmark: pgfId-8440435]Note Even if you cannot add a new host to the network map, the system still performs access control on that host’s network traffic. Although reaching the FireSIGHT host limit does not prevent you from performing access control on hosts discovered after you reached your licensed limit, you cannot view or perform analysis on those hosts using host profile data. For example, you cannot use compliance white lists to monitor network compliance for those hosts, or use those hosts in host profile qualifications, and so on.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8439341]You can also manually delete a host, an entire subnet, or all of your hosts from the network map. Keep in mind, however, that if the system detects activity associated with a deleted host, it re-adds the host to the network map.
 
     [bookmark: pgfId-8439313]Note also that if the system has not detected network traffic from a host in the last Host Timeout period specified in your network discovery policy, the host is removed from the network map. The default setting is 10080 minutes (7 days).
 
     [bookmark: pgfId-8439295]To help you track your host license use, the FireSIGHT Host License Limit health module warns you if you have fewer than a configurable number of host licenses left.
 
    
 
     
      [bookmark: pgfId-8370896][bookmark: 34526]Understanding the FireSIGHT User Limit
 
     [bookmark: pgfId-8370911]License: FireSIGHT
 
     [bookmark: pgfId-8371644]The FireSIGHT license on your Defense Center determines how many individual users you can monitor. When the system detects activity from a new user, that user is added to the Users database. You can detect users in the following ways:
 
      
      	 [bookmark: pgfId-8371702]You can use the network discovery policy to configure managed devices to passively detect logins for LDAP, AIM, POP3, IMAP, Oracle, SIP (VoIP), FTP, HTTP, MDNS, and SMTP users.
 
      	 [bookmark: pgfId-8371768]You can install User Agents on your Microsoft Active Directory LDAP servers to detect authentications against Active Directory credentials.
 
     
 
     [bookmark: pgfId-8372244]After you reach the licensed limit, in most cases the system stops adding new users to the database. To add new users, you must either manually delete users from the database, or purge all users from the database. 
 
     [bookmark: pgfId-8372343]However, the system favors authoritative user logins. If you have reached the licensed limit and the system detects an authoritative user login for a previously undetected user, the system deletes the non-authoritative user who has remained inactive for the longest time, and replaces it with the new user.
 
      
       
     
 
     
 
     [bookmark: pgfId-8371963]Tip Note that if you are using managed devices to detect user activity, you can restrict user logging by protocol to help minimize username clutter and preserve FireSIGHT user licenses. For example, monitoring users discovered via AIM, POP3, and IMAP may add users not relevant to your organization due to network access from contractors, visitors, and other guests. For more information, see Restricting User Logging.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8370897][bookmark: 84698]Understanding the Access-Controlled[bookmark: marker-8375231] User Limit
 
     [bookmark: pgfId-8370936]License: Control
 
     [bookmark: pgfId-8437441]Supported Devices: Series 3, Virtual, ASA FirePOWER
 
     [bookmark: pgfId-8448572]The FireSIGHT license on your Defense Center determines not only how many individual users you can monitor, but also how many users you can use in access control rules to perform user control. These users are called access-controlled users.
 
      
       
     
 
     
 
     [bookmark: pgfId-8372828]Note To perform user control, your organization must use Microsoft Active Directory. The system uses User Agents running on Active Directory servers to associate access-controlled users with IP addresses, which is what allows access control rules to trigger.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8373005]You specify the groups that access-controlled users must belong to by configuring a connection (called a user awareness object) between the Defense Center and an Active Directory server. Then, on a regular basis, the Defense Center queries the server and retrieves a list of the users in the groups you specified in the authentication object. You can then use these users to perform access control. 
 
     [bookmark: pgfId-8399493]You must make sure the total number of users in the groups you specify in the authentication object is less than your FireSIGHT user license. If your parameters are too broad, the Defense Center obtains information on as many users as it can and reports the number of users it failed to retrieve in the task queue. For performance and licensing reasons, Cisco recommends that you specify only the groups that represent the users you want to use in access control.
 
    
 
   
 
    
     [bookmark: pgfId-8391887][bookmark: 91845]Viewing Your Lic[bookmark: marker-8391886]enses
 
    [bookmark: pgfId-8391888]License: Any
 
    [bookmark: pgfId-8349539]Use the Licenses page to view the licenses for a Defense Center and its managed devices. For each type of appliance in your deployment, the page lists the total number of licenses you have as well as the portion of those licenses that are in use.
 
    [bookmark: pgfId-8349558]Keep in mind that on this page, the number of FireSIGHT User licenses in use represents the number of users detected by the FireSIGHT System, that is, the number of users in the Users database. It does not represent the number of access-controlled users you are using for access control. For more information, see Understanding FireSIGHT Host and User License Limits. 
 
    [bookmark: pgfId-8425656]The Licenses page also provides details on each of your licenses. For each model, you can see how many licenses of each type you have, and how many managed devices you can license with each type of license. For licenses that expire, the page provides you with the expiration date.
 
    [bookmark: pgfId-8425527]Other than the Licenses page, there are a few other ways you can view licenses and license limits:
 
     
     	 [bookmark: pgfId-8350281]The Product Licensing dashboard widget provides an at-a-glance overview of your licenses.
 
     	 [bookmark: pgfId-8439271]The Device Management page ( Devices > Device Management ) lists the licenses applied to each of your managed devices.
 
     	 [bookmark: pgfId-8439275]Two health modules, License Monitor and FireSIGHT Host License Limit, communicate license status when used in a health policy.
 
    
 
    [bookmark: pgfId-8322287]To view your licenses:
 
    [bookmark: pgfId-8322288]Access: Admin
 
    
 
    [bookmark: pgfId-8322292]Step 1 Select System > Licenses.
 
    [bookmark: pgfId-8322293]The Licenses page appears.
 
    [bookmark: pgfId-8456641]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8350791][bookmark: 48506]Adding a Licen[bookmark: marker-8375281]se to the Defense Center
 
    [bookmark: pgfId-8353562]License: Any
 
    [bookmark: pgfId-8357479]Before you add a license to the Defense Center, make sure you have the activation key provided by Cisco when you purchased the license.
 
    [bookmark: pgfId-8353839]With the exception of FireSIGHT, you must enable licenses on your managed devices before you can use licensed features. You can enable a license either when you add a device to the Defense Center, or by editing the device’s general properties after you add the device, Note that because Series 2 devices automatically have Protection capabilities, with the exception of Security Intelligence filtering, you cannot disable these capabilities, nor can you apply other licenses to a Series 2 device. See Changing a Device’s Licensed Capabilities.
 
     
      
    
 
    
 
    [bookmark: pgfId-8443327]Note If you add licenses after a backup has completed, these licenses will not be removed or overwritten if this backup is restored. To prevent a conflict on restore, remove those licenses before restoring the backup, noting where the licenses were used, and add and reconfigure them after restoring the backup. If a conflict occurs, contact Support.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8353563]To add a license:
 
    [bookmark: pgfId-8353564]Access: Admin
 
    
 
    [bookmark: pgfId-8353496]Step 1 Select System > Licenses.
 
    [bookmark: pgfId-8353497]The Licenses page appears.
 
    [bookmark: pgfId-8353420]Step 2 Click Add New License.
 
    [bookmark: pgfId-8353421]The Add License page appears.
 
    [bookmark: pgfId-8353426]Step 3 Did you receive an email with your license?
 
     
      
      	 [bookmark: pgfId-8353747]If yes, copy the license from the email, paste it into the  License field, and click  Submit License .
 
     
 
    
 
    [bookmark: pgfId-8353781]If the license is correct, the license is added. Skip the rest of the procedure.
 
     
      
      	 [bookmark: pgfId-8353758]If no, click  Get License .
 
     
 
    
 
    [bookmark: pgfId-8475196]The Licensing Center web site appears. If you cannot access the Internet, switch to a computer that can. Note the license key at the bottom of the page and browse to https://tools.cisco.com/SWIFT/LicensingUI/Home.
 
    [bookmark: pgfId-8475198]Step 4 Follow the on-screen instructions to obtain your license, which will be sent to you in an email.
 
     
      
    
 
    
 
    [bookmark: pgfId-8374069]Tip You can also request a license on the Licenses tab after you log into the Support Site.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8353969]Step 5 Copy the license from the email, paste it into the License field in the Defense Center’s web interface, and click Submit License.
 
    [bookmark: pgfId-8353436]If the license is valid, it is added. You can now enable the license’s capabilities on your managed devices, as described in Changing a Device’s Licensed Capabilities.
 
    [bookmark: pgfId-8456679]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8350818][bookmark: 26572]Deleting a Lic[bookmark: marker-8375289]ense
 
    [bookmark: pgfId-8475256]License: Any
 
    [bookmark: pgfId-8475257]Use the following procedure if you need to delete a license for any reason. Keep in mind that because Cisco generates licenses based on each Defense Center’s unique license key, when you delete the license from one Defense Center and then reuse it on a different Defense Center, you must request a new license based on the license key from the new Defense Center.
 
    [bookmark: pgfId-8475270]In most cases, deleting a license removes your ability to use features enabled by that license. For more information, see Service Subscriptions.
 
    [bookmark: pgfId-8351577]To delete a license:
 
    [bookmark: pgfId-8351578]Access: Admin
 
    
 
    [bookmark: pgfId-8351579]Step 1 Select System > Licenses.
 
    [bookmark: pgfId-8351580]The Licenses page appears.
 ). 
    
 
    [bookmark: pgfId-8374673]Deleting a license removes the licensed capability from all devices using that license. For example, if your Protection license is valid for and enabled on 100 managed devices, deleting the license removes Protection capabilities from all 100 devices.
 
    [bookmark: pgfId-8374680]Step 3 Confirm that you want to delete the license.
 
    [bookmark: pgfId-8374681]The license is deleted.
 
    [bookmark: pgfId-8456693]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8373321][bookmark: 38942]Changing a Device’s Licensed Capa[bookmark: marker-8375303]bilities
 
    [bookmark: pgfId-8443727]License: Any
 
    [bookmark: pgfId-8445192]Supported Devices: Series 3, Virtual, X-Series, ASA FirePOWER
 
    [bookmark: pgfId-8448619]To change the licensed capabilities of a Series 3 device, virtual device, Cisco NGIPS for Blue Coat X-Series, or ASA FirePOWER device, edit the device’s general properties on the Device Management page. Although there are some exceptions, you cannot use the features associated with a license if you disable it on a managed device.
 
    [bookmark: pgfId-8471896]Series 2 devices automatically have Protection capabilities, with the exception of Security Intelligence filtering. You cannot disable these capabilities, nor can you apply other licenses to a Series 2 device. Note that, although you cannot use a Malware or URL Filtering license with a DC500 Defense Center, you can use a DC500 to enable or change these and other licensed capabilities of a Series 3 device, virtual device, Cisco NGIPS for Blue Coat X-Series, or ASA FirePOWER device.
 
    [bookmark: pgfId-8471918]For detailed information on the licenses you can enable, including version, model, and other requirements, see Service Subscriptions.
 
    [bookmark: pgfId-8373361]To enable or disable a device’s licensed capabilities:
 
    [bookmark: pgfId-8373362]Access: Admin/Network Admin
 
    
 
    [bookmark: pgfId-8373363]Step 1 Select Devices > Device Management.
 
    [bookmark: pgfId-8373567]The Device Management page appears.
 ). 
    
 
    [bookmark: pgfId-8373523]The Interfaces tab for that device appears.
 
    [bookmark: pgfId-8373370]Step 3 Click Device.
 
    [bookmark: pgfId-8373371]The Device tab appears.
 ). 
    
 
    [bookmark: pgfId-8373373]The License pop-up window appears.
 
    [bookmark: pgfId-8373374]Step 5 Enable or disable the licensed capabilities of the device by clearing or selecting the appropriate check boxes.
 
    [bookmark: pgfId-8374662]Step 6 Click Save.
 
    [bookmark: pgfId-8374663]The changes are saved but do not take effect until you apply the device configuration; see Applying Changes to Devices.
 
    [bookmark: pgfId-8456707]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8363866]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-8087658][bookmark: 75941]Updating S[bookmark: marker-8087655]ystem Softw[bookmark: marker-8087657]are 
      
      
 
     
 
 
    [bookmark: pgfId-8087662]Cisco electronically distributes several different types of updates, including major and minor updates to the system software itself, as well as rule updates, geolocation database (GeoDB) updates, and Vulnerability Database (VDB) updates.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8135718] 
     Caution This chapter contains general information on updating the FireSIGHT System. Before you update any part of the FireSIGHT System, including the VDB, GeoDB, or intrusion rules, you 
     must read the release notes or advisory text that accompanies the update. The release notes provide important information, including supported platforms, compatibility, prerequisites, warnings, and specific installation and uninstallation instructions. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8139283]Unless otherwise documented in the release notes or advisory text, updating an appliance does not modify its configuration; the settings on the appliance remain intact.
 
    [bookmark: pgfId-8135724]See the following sections for more information:
 
     
     	 [bookmark: pgfId-8135728]Understanding Update Types
 
     	 [bookmark: pgfId-7775092]Performing Software Updates
 
     	 [bookmark: pgfId-2561142]Uninstalling Software Updates
 
     	 [bookmark: pgfId-8024887]Updating the Vulnerability Database
 
     	 [bookmark: pgfId-8036580]Importing Rule Updates and Local Rule Files
 
     	 [bookmark: pgfId-8157497]Updating the Geolocation Database
 
    
 
   
 
    
     [bookmark: pgfId-8036582][bookmark: 84942]Understanding Update Types
 
    [bookmark: pgfId-8024902]License: Any
 
    [bookmark: pgfId-7799764]Cisco electronically distributes several different types of updates, including major and minor updates to the system software itself, as well as intrusion rule updates and VDB updates.
 
    [bookmark: pgfId-8124253]The following table describes the types of updates provided by Cisco. For most update types, you can schedule their download and installation; see Scheduling Tasks and Using Recurring Rule Updates. 
 
    [bookmark: pgfId-7775940]
 
     
      
       
       [bookmark: pgfId-8196487]Table 66-1 [bookmark: 11019]FireSIGHT System Update Types
 
       
       
        
        	 
          
          [bookmark: pgfId-8124389]Update Type 
         
  
        	 
          
          [bookmark: pgfId-8124391]Description 
         
  
        	 
          
          [bookmark: pgfId-8124393]Schedule? 
         
  
        	 
          
          [bookmark: pgfId-8124395]Uninstall? 
         
  
       
 
        
        	[bookmark: pgfId-8124397]patches to the FireSIGHT System
  
        	[bookmark: pgfId-8124402]Patches include a limited range of fixes (and usually change the fourth digit in the version number; for example, 5.4.0.1).
  
        	[bookmark: pgfId-8124404]yes
  
        	[bookmark: pgfId-8124406]yes
  
       
 
        
        	[bookmark: pgfId-8124408]feature updates to the FireSIGHT System
  
        	[bookmark: pgfId-8124413]Feature updates are more comprehensive than patches and generally include new features (and usually change the third digit in the version number; for example, 5.4.1).
  
        	[bookmark: pgfId-8124415]yes
  
        	[bookmark: pgfId-8124417]yes
  
       
 
        
        	[bookmark: pgfId-8124419]major updates (major and minor version releases) to the FireSIGHT System
  
        	[bookmark: pgfId-8124424]Major updates, sometimes referred to as upgrades, include new features and functionality and may entail large-scale changes to the product (and usually change the first or second digit in the version number; for example, 5.3 or 5.4). 
  
        	[bookmark: pgfId-8124427]no
  
        	[bookmark: pgfId-8124429]no
  
       
 
        
        	[bookmark: pgfId-8124431]VDB 
  
        	[bookmark: pgfId-8124433]VDB updates affect the vulnerabilities reported by the FireSIGHT System as well as the detected operating systems, applications, and clients.
  
        	[bookmark: pgfId-8124438]yes
  
        	[bookmark: pgfId-8124440]no
  
       
 
        
        	[bookmark: pgfId-8124442]intrusion rules
  
        	[bookmark: pgfId-8124444]Intrusion rule updates provide new and updated intrusion rules and preprocessor rules, modified states for existing rules, and modified default intrusion policy settings. Rule updates may also delete rules, provide new rule categories and default variables, and modify default variable values. 
  
        	[bookmark: pgfId-8124446]yes
  
        	[bookmark: pgfId-8124448]no
  
       
 
        
        	[bookmark: pgfId-8156866]geolocation database (GeoDB)
  
        	[bookmark: pgfId-8156868]GeoDB updates provide updated information on physical locations, connection types, and so on that your system can associate with detected routable IP addresses. You can use geolocation data as a condition in access control rules. You must install the GeoDB to view geolocation details.
 [bookmark: pgfId-8168601]The DC500 Defense Center does not support this feature.
  
        	[bookmark: pgfId-8156870]yes
  
        	[bookmark: pgfId-8156872]no
  
       
 
       
     
 
    
 
    [bookmark: pgfId-8124287]Note that while you can uninstall patches and other minor updates to the FireSIGHT System, you cannot uninstall major updates or return to previous versions of the VDB, GeoDB, or intrusion rules. If you updated your appliance to a new major version of the FireSIGHT System, and you need to revert to an older version, contact Support.
 
   
 
    
     [bookmark: pgfId-7775954][bookmark: 37465]Performing Software Updates[bookmark: marker-7775943]
 
    [bookmark: pgfId-8135490]License: Any
 
    [bookmark: pgfId-8217974]There are a few basic steps to updating your FireSIGHT System deployment. First, you must prepare for the update by reading the release notes and completing any required pre-update tasks. Then, you can begin the update — first update your Defense Centers, then the devices they manage. You must monitor the update’s progress until it completes, then verify the update’s success. Finally, complete any required post-update steps.
 
    [bookmark: pgfId-8217979]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-8135592]Planning for the Update
 
     	 [bookmark: pgfId-8128296]Understanding the Update Process
 
     	 [bookmark: pgfId-8127335]Updating a Defense Center
 
     	 [bookmark: pgfId-8127626]Updating Managed Devices
 
     	 [bookmark: pgfId-8127639]Monitoring the Status of Major Updates
 
    
 
     
      [bookmark: pgfId-8127195][bookmark: 31352]Planning for the Update
 
     [bookmark: pgfId-8128391]License: Any
 
     [bookmark: pgfId-8129493]Before you begin the update, you must thoroughly read and understand the release notes, which you can download from the Support Site. The release notes describe supported platforms, new features and functionality, known and resolved issues, and product compatibility. The release notes also contain important information on prerequisites, warnings, and specific installation and uninstallation instructions.
 
     [bookmark: pgfId-8131497]The following sections provide an overview of some of the factors you must consider when planning for the update.
 
     [bookmark: pgfId-8129452]FireSIGHT System Version Requirements
 
     [bookmark: pgfId-8130237]You must make sure your appliances (including software-based devices) are running the correct version of the FireSIGHT System. The release notes indicate the required version. If you are running an earlier version, you can obtain updates from the Support Site.
 
     [bookmark: pgfId-8130660]Operating System Requirements
 
     [bookmark: pgfId-8129461]Make sure the computers where you installed software-based devices are running the correct versions of their operating systems. The release notes indicate the required versions. For information on supported operating systems for virtual devices, see the FireSIGHT System Virtual Installation Guide. For information on supported operating systems for Cisco NGIPS for Blue Coat X-Series, see the Cisco NGIPS for Blue Coat X-Series Installation Guide.
 
     [bookmark: pgfId-8129462]Time and Disk Space Requirements
 
     [bookmark: pgfId-8132713]Make sure you have enough free disk space and allow enough time for the update. When you update a managed device, the update requires additional disk space on the Defense Center. The release notes indicate space and time requirements.
 
     [bookmark: pgfId-8132755]Configuration and Event Backup Guidelines
 
     [bookmark: pgfId-8129463]Before you begin a major update, Cisco recommends that you delete any backups that reside on the appliance after copying them to an external location. Regardless of the update type, you should also back up current event and configuration data to an external location. Event data is not backed up as part of the update process.
 
     [bookmark: pgfId-8129468]You can use the Defense Center to back up event and configuration data for itself and the devices it manages; see Using Backup and Restore.
 
     [bookmark: pgfId-8134302]When to Perform the Update
 
     [bookmark: pgfId-8134303]Because the update process may affect traffic inspection, traffic flow, and link state, and because the Data Correlator is disabled while an update is in progress, Cisco recommends you perform the update in a maintenance window or at a time when the interruption will have the least impact on your deployment.
 
    
 
     
      [bookmark: pgfId-8128501][bookmark: 50647]Understanding the Update Process
 
     [bookmark: pgfId-8128537]License: Any
 
      
      [image: ] 
     
 
     [bookmark: pgfId-8139540]Order of Update
 
     [bookmark: pgfId-8139544]You must update your Defense Centers before you can update the devices they manage.
 
     [bookmark: pgfId-8134743]Use the Defense Center to Perform the Update 
 
     [bookmark: pgfId-8137717]Cisco recommends that you use the Defense Center’s web interface to update not only itself, but also the devices it manages. You must use the Defense Center to update managed devices that do not have a web interface, such as virtual devices and Cisco NGIPS for Blue Coat X-Series. For major updates to Cisco NGIPS for Blue Coat X-Series, you may need to uninstall the previous version and install the new version. See the Cisco NGIPS for Blue Coat X-Series Installation Guide for more information.
 
     [bookmark: pgfId-8137723]The Product Updates page (System > Updates) shows the version of each update, as well as the date and time it was generated. It also indicates whether a reboot is required as part of the update.
 
     [bookmark: pgfId-8137731]When you upload updates obtained from Support to your appliance, they appear on the page. Uninstallers for patch and feature updates also appear; see Uninstalling Software Updates. On the Defense Center, the page can list VDB updates.
 
      
       
     
 
     
 
     [bookmark: pgfId-8137738]Tip For patches and feature updates, you can take advantage of the automated update feature; see Automating Software Updates.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8137743][bookmark: 68883]Updating Paired Defense Centers
 
     [bookmark: pgfId-8137747]When you begin to update one Defense Center in a high availability pair, the other Defense Center in the pair becomes the primary, if it is not already. In addition, the paired Defense Centers stop sharing configuration information; paired Defense Centers do not receive software updates as part of the regular synchronization process.
 
     [bookmark: pgfId-8137748]To ensure continuity of operations, do not update paired Defense Centers at the same time. First, complete the update procedure for the secondary Defense Centers, then update the primary.
 
     [bookmark: pgfId-8137749]Updating Clustered Devices
 
     [bookmark: pgfId-8138546]When you install an update on clustered devices or clustered stacks, the system performs the update on the devices or stacks one at a time. When the update starts, the system first applies it to the backup device or stack, which goes into maintenance mode until any necessary processes restart and the device or stack is processing traffic again. The system then applies the update to the active device or stack, which follows the same process.
 
     [bookmark: pgfId-8169146]To update devices in a clustered stack, you must perform the update from the managing Defense Center on all members of a cluster at once; you cannot perform the upgrade directly from the devices.
 
     [bookmark: pgfId-8138547]Updating Stacked Devices
 
     [bookmark: pgfId-8138548]When you install an update on stacked devices, the system performs the updates simultaneously. Each device resumes normal operation when the update completes. Note that:
 
      
      	 [bookmark: pgfId-8138549]If the primary device completes the update  before all of the secondary devices, the stack operates in a limited, mixed-version state until all devices have completed the update. 
 
      	 [bookmark: pgfId-8138550]If the primary device completes the upgrade  after all of the secondary devices, the stack resumes normal operation when the update completes on the primary device.
 
     
 
     [bookmark: pgfId-8138551]Traffic Flow and Inspection
 
     [bookmark: pgfId-8138552]When you install or uninstall updates from a managed device, the following capabilities may be affected:
 
      
      	 [bookmark: pgfId-8138553]traffic inspection, including application and user awareness and control, URL filtering, Security Intelligence filtering, intrusion detection and prevention, and connection logging 
 
      	 [bookmark: pgfId-8138554]traffic flow, including switching, routing, and related functionality
 
      	 [bookmark: pgfId-8138555]link state
 
     
 
     [bookmark: pgfId-8154432]The Data Correlator does not run during system updates. It resumes when the update is complete.
 
     [bookmark: pgfId-8138556]The manner and duration of network traffic interruption depends on the components of the FireSIGHT System that the update affects, how your devices are configured and deployed, and whether the update reboots the device. For specific information on how and when network traffic is affected for a particular update, see the release notes.
 
      
       
     
 
     
 
     [bookmark: pgfId-8138560]Tip When you update clustered devices, the system performs the updates one at a time to avoid traffic interruption.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8138562][bookmark: 15703]Using the Web Interface During the Update
 
     [bookmark: pgfId-8138563]Regardless of the type of update, do not use the web interface of the appliance you are updating to perform tasks other than monitoring the update.
 
     [bookmark: pgfId-8138564]To prevent you from using an appliance during a major update, and to allow you to easily monitor a major update’s progress, the system streamlines the appliance’s web interface. You can monitor a minor update's progress in the task queue (System > Monitoring > Task Status). Although you are not prohibited from using the web interface during a minor update, Cisco recommends against it.
 
      
       
     
 
     
 
     [bookmark: pgfId-8138568]Tip To monitor updates to its managed devices, use the task queue on the Defense Center.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8138572]Even for minor updates, the web interface on the updating appliance may become unavailable during the update process, or the appliance may log you out. This is expected behavior. If this occurs, log in again to view the task queue. If the update is still running, you must continue to refrain from using the web interface until the update has completed. Note that while updating, managed devices may reboot a second time; this is also expected behavior.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8122532] 
      Caution If you encounter issues with the update (for example, if the web interface indicates that the update has failed or if a manual refresh of the task queue or Update Status page shows no progress), do 
      not restart the update. Instead, contact Support. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8116625][bookmark: 92195]After the Update
 
     [bookmark: pgfId-8124746]You must complete all of the post-update tasks listed in the release notes to ensure that your deployment is performing properly.
 
     [bookmark: pgfId-8124747]The most important post-update task is to reapply access control policies, both after you update the Defense Center and then again after you update its managed devices.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8251300] 
      Caution When you apply an access control policy, resource demands may result in a small number of packets dropping without inspection. Additionally, applying some configurations requires the Snort process to restart, which temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      Applying an Access Control Policy and 
      Configurations that Restart the Snort Process. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8118900]Additionally, you should:
 
      
      	 [bookmark: pgfId-8118856]verify that the update succeeded
 
      	 [bookmark: pgfId-8118857]make sure that all appliances in your deployment are communicating successfully
 
      	 [bookmark: pgfId-8118858]update your intrusion rules, VDB, and GeoDB, if necessary
 
      	 [bookmark: pgfId-8138530]make any required configuration changes, based on the information in the release notes
 
      	 [bookmark: pgfId-8138531]perform any additional post-update tasks listed in the release notes
 
     
 
    
 
     
      [bookmark: pgfId-8138539][bookmark: 21634]Updatin[bookmark: marker-8138533]g a[bookmark: marker-8138534] Defense Center
 
     [bookmark: pgfId-8096201]License: Any
 
     [bookmark: pgfId-8096218]Update the Defense Center in one of two ways, depending on the type of update and whether your Defense Center has access to the Internet:
 
      
      	 [bookmark: pgfId-8093907]You can use the Defense Center to obtain the update directly from the Support Site, if your Defense Center has access to the Internet. This option is  not supported for major updates.
 
      	 [bookmark: pgfId-7739819]You can manually download the update from the Support Site and then upload it to the Defense Center. Choose this option if your Defense Center does not have access to the Internet or if you are performing a major update.
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8120885] 
      Caution To ensure continuity of operations, do 
      not update paired Defense Centers at the same time; see 
      Updating Paired Defense Centers. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8121097]For major updates, updating the Defense Center removes uninstallers for previous updates.
 
     [bookmark: pgfId-8096248]To update the Defense Center
 
     [bookmark: pgfId-8096249]Access: Admin
 
     
 
     [bookmark: pgfId-7720565]Step 1 Read the release notes and complete any required pre-update tasks.
 
     [bookmark: pgfId-7735501]Pre-update tasks may include making sure that: the Defense Center is running the correct version of the Cisco software, you have enough free disk space to perform the update, you set aside adequate time to perform the update, you backed up event and configuration data, and so on.
 
     [bookmark: pgfId-7740040]Step 2 Upload the update to the Defense Center. You have two options, depending on the type of update and whether your Defense Center has access to the Internet:
 
      
       
       	 [bookmark: pgfId-7740100]For all except major updates, and if your Defense Center has access to the Internet, select  System > Updates , then click  Download Updates  to check for the latest updates. For major updates, or if your Defense Center does not have access to the Internet, you must first manually download the update. Download the updates from either of the following Support Sites:
 
      
 
     
 
     [bookmark: pgfId-8246343] – For all Sourcefire updates: (https://support.sourcefire.com/)
 
     [bookmark: pgfId-8246406] – For Cisco updates:
 
      
      [bookmark: pgfId-8246737]Physical Defense Center 
(http://software.cisco.com/download/navigator.html?mdfid=278875421) 
     
 
      
      [bookmark: pgfId-8246625]Virtual Defense Center_
(http://software.cisco.com/download/type.html?mdfid=286259687&catid=null) 
     
 
      
       
       	 [bookmark: pgfId-8246407]Select  System > Updates , then click  Upload Update . Browse to the update and click  Upload .
 
      
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7740139]Note Download the update directly from the Support Site, either manually or by clicking Download Updates on the Product Updates tab. If you transfer an update file by email, it may become corrupted.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7740153]The update is uploaded to the Defense Center.
 
     [bookmark: pgfId-8058557]Step 3 Make sure that the appliances in your deployment are successfully communicating and that there are no issues being reported by the health monitor.
 
     [bookmark: pgfId-8058558]Step 4 Select System > Monitoring > Task Status to view the task queue and make sure that there are no jobs in process.
 
     [bookmark: pgfId-7739751]Tasks that are running when the update begins are stopped and cannot be resumed; you must manually delete them from the task queue after the update completes. The task queue automatically refreshes every 10 seconds. You must wait until any long-running tasks are complete before you begin the update.
 
     [bookmark: pgfId-7724978]Step 5 Select System > Updates.
 
     [bookmark: pgfId-8077012]The Product Updates page appears.
 
     [bookmark: pgfId-8077013]Step 6 Click the install icon next to the update you uploaded.
 
     [bookmark: pgfId-8077014]The Install Update page appears.
 
     [bookmark: pgfId-8037916]Step 7 Select the Defense Center and click Install. If prompted, confirm that you want to install the update and reboot the Defense Center.
 
     [bookmark: pgfId-7819035]The update process begins. How you monitor the update depends on whether the update is a major or minor update. See the FireSIGHT System Update Types table and the release notes to determine your update type:
 
      
       
       	 [bookmark: pgfId-7819039]For minor updates, you can monitor the update’s progress in the task queue ( System > Monitoring > Task Status ).
 
       	 [bookmark: pgfId-8138699]For major updates, you can begin monitoring the update’s progress in the task queue. However, after the Defense Center completes its necessary pre-update checks, you are logged out. When you log back in, the Upgrade Status page appears. See Monitoring the Status of Major Updates for information.
 
      
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8138706] 
      Caution Regardless of the update type, do 
      not use the web interface to perform tasks other than monitoring the update until the update has completed and, if necessary, the Defense Center reboots. For more information, see 
      Using the Web Interface During the Update. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8138716]Step 8 After the update finishes, if necessary, log into the Defense Center.
 
     [bookmark: pgfId-8138717]If you are the first user to log in after a major update, the End User License Agreement (EULA) may appear. You must review and accept the EULA to continue.
 
     [bookmark: pgfId-8138696]Step 9 Clear your browser cache and force a reload of the browser. Otherwise, the user interface may exhibit unexpected behavior.
 
     [bookmark: pgfId-8027167]Step 10 Select Help > About and confirm that the software version is listed correctly. Also note the versions of the rule update and VDB on the Defense Center; you will need this information later.
 
     [bookmark: pgfId-7719106]Step 11 Verify that all managed devices are successfully communicating with the Defense Center.
 
     [bookmark: pgfId-8027195]Step 12 If the rule update available on the Support Site is newer than the rules on your Defense Center, import the newer rules. 
 
     [bookmark: pgfId-8027218]For more information, see Importing Rule Updates and Local Rule Files.
 
     [bookmark: pgfId-8042642]Step 13 Reapply access control policies.
 
     [bookmark: pgfId-8251562]When you apply an access control policy, resource demands may result in a small number of packets dropping without inspection. Additionally, applying some configurations requires the Snort process to restart, which temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See Applying an Access Control Policy and Configurations that Restart the Snort Process.
 
     [bookmark: pgfId-8251576]Step 14 If the VDB available on the Support Site is newer than the VDB on your Defense Center, install the latest VDB.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8256103] 
      Caution Installing a VDB update restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
      How Snort Restarts Affect Traffic and 
      Updating the Vulnerability Database for more information. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7731546]Step 15 Continue with the next section, Updating Managed Devices, to update Cisco software on the devices that the Defense Center manages.
 
     [bookmark: pgfId-8202918]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7731554][bookmark: 33617]Updating Managed Devices
 
     [bookmark: pgfId-8025254]License: Any
 
     [bookmark: pgfId-7723452]After you update your Defense Centers, Cisco recommends that you use them to update the devices they manage. You must use the Defense Center to update managed devices that do not have a web interface, such as virtual devices and Cisco NGIPS for Blue Coat X-Series. For major updates to Cisco NGIPS for Blue Coat X-Series, you may need to uninstall the previous version and install the new version.
 
     [bookmark: pgfId-8121254]Updating managed devices is a two-step process. First, download the update from either of the following Support Sites and upload it to the managing Defense Center:
 
      
      	 [bookmark: pgfId-8209021] Sourcefire: ( https://support.sourcefire.com/ )
 
      	 [bookmark: pgfId-8209012] Cisco: ( http://www.cisco.com/cisco/web/support/index.html )
 
     
 
     [bookmark: pgfId-8209631]Next, install the software.
 
      
       
     
 
     
 
     [bookmark: pgfId-8066978]Note Traffic inspection, traffic flow, and link state may be affected during the update, depending on how your devices are configured and deployed, the components that the update affects, and whether the update reboots the devices. For specific information on how and when network traffic is affected for a particular update, see the release notes for that update.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7723000]To update managed devices:
 
     [bookmark: pgfId-7723001]Access: Admin
 
     
 
     [bookmark: pgfId-7725006]Step 1 Read the release notes and complete any required pre-update tasks.
 
     [bookmark: pgfId-8096293]Pre-update tasks may include updating your managing Defense Center, backing up event and configuration data, and making sure that the devices are running the correct version of the Cisco software, that computers where you installed software-based devices are running the correct version of their operating systems, that you have enough free disk space to perform the update, that you have set aside adequate time to perform the update, and so on.
 
     [bookmark: pgfId-7736086]Step 2 Update the FireSIGHT System software on the devices’ managing Defense Center; see Updating a Defense Center.
 
     [bookmark: pgfId-8097972]Step 3 Download the update from either of the following Support Sites:
 
      
       
       	 [bookmark: pgfId-8209133] For all Sourcefire updates: ( https://support.sourcefire.com/ )
 
       	 [bookmark: pgfId-8246921] For Cisco updates: 
 
      
 
     
 
      
      [bookmark: pgfId-8246922]physical managed devices: (http://software.cisco.com/download/navigator.html?mdfid=278875421) 
     
 
      
      [bookmark: pgfId-8246923]virtual managed devices: (http://software.cisco.com/download/type.html?mdfid=286259690&flowid=70802) 
     
 
     [bookmark: pgfId-8097973]Different device models may use different updates. For information on the updates you can download, see the release notes.
 
      
       
     
 
     
 
     [bookmark: pgfId-7723206]Note Download the update directly from the Support Site. If you transfer an update file by email, it may become corrupted.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7736116]Step 4 Make sure that the appliances in your deployment are successfully communicating and that there are no issues being reported by the health monitor.
 
     [bookmark: pgfId-7723262]Step 5 On the managing Defense Center, select System > Updates.
 
     [bookmark: pgfId-7724611]The Product Updates page appears.
 
     [bookmark: pgfId-7723393]Step 6 Click Upload Update to browse to the update you downloaded, then click Upload.
 
     [bookmark: pgfId-7723397]The update is uploaded to the Defense Center. The Product Updates tab shows the type of update you just uploaded, its version number, and the date and time when it was generated. The page also indicates whether a reboot is required as part of the update.
 
     [bookmark: pgfId-7723430]Step 7 Click the install icon next to the update you are installing.
 
     [bookmark: pgfId-7823053]The Install Update page appears.
 
     [bookmark: pgfId-7823098]Step 8 Select the devices where you want to install the update, then click Install; you can update multiple [bookmark: marker-8121366]devices at once if they use the same update. If prompted, confirm that you want to install the update and reboot the devices.
 
     [bookmark: pgfId-7822605]The update process begins. Depending on the size of the file, it may take some time to install the update on all devices. You can monitor the update's progress in the Defense Center’s task queue (System > Monitoring > Task Status). Note that managed devices may reboot twice during the update; this is normal.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-8098485] 
      Caution If you encounter issues with the update (for example, if the task queue indicates that the update has failed or if a manual refresh of the task queue shows no progress), do 
      not restart the update. Instead, contact Support. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8100380]Step 9 Optionally, after a major update, log in to the device’s local web interface.
 
     [bookmark: pgfId-8121547]If you are the first user to log in after a major update, the End User License Agreement (EULA) may appear. You must review and accept the EULA to continue. Note that the EULA also appears, and must be accepted, if your first login is via the command line interface rather than the web interface.
 
     [bookmark: pgfId-8100384]Step 10 On the Defense Center, select Devices > Device Management and confirm that the devices you updated have the correct version listed.
 
     [bookmark: pgfId-7724388]Step 11 Verify that the devices you updated are successfully communicating with the Defense Center.
 
     [bookmark: pgfId-8042931]Step 12 Reapply access control policies.
 
     [bookmark: pgfId-8251631]When you apply an access control policy, resource demands may result in a small number of packets dropping without inspection. Additionally, applying some configurations requires the Snort process to restart, which temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See Applying an Access Control Policy and Configurations that Restart the Snort Process.
 
     [bookmark: pgfId-8202866]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7819128][bookmark: 46258]Monitoring the Status of Major Updates
 
     [bookmark: pgfId-8025456]License: Any
 
     [bookmark: pgfId-7819143]For major updates, the FireSIGHT System provides you with a streamlined web interface so that you can easily monitor the update process. The streamlined interface also prevents you from using the web interface to perform tasks other than monitoring the update.
 
     [bookmark: pgfId-8038408]You can begin monitoring the update’s progress in the task queue (System > Monitoring > Task Queue). However, after the appliance completes its necessary pre-update checks, you and all other users are logged out of the web interface. Unless you are an administrator or a maintenance user, you cannot log back in until the update is complete.
 
     [bookmark: pgfId-7819154]For administrators, when you log back in, the streamlined update page appears.
 
     [bookmark: pgfId-8173660]When using a Defense Center to update a managed device, Cisco recommends that you monitor the update’s progress from the Defense Center’s task queue. Note, however, that if you attempt to log into the device’s local web interface after the appliance finishes its pre-update checks, the streamlined update page appears and you can use it to monitor the update’s progress.
 
     [bookmark: pgfId-7819179]The page displays the version of the FireSIGHT System you are updating from, the version you are updating to, and the time that has elapsed since the update began. It also displays a progress bar and gives details about the script currently running.
 
      
       
     
 
     
 
     [bookmark: pgfId-7819180]Tip Click show log for current script to see the update log. Click hide log for current script to hide the log again.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7819181]If the update fails for any reason, the page displays an error message indicating the time and date of the failure, which script was running when the update failed, and instructions on how to contact Support. Do not restart the update.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7819182] 
      Caution If you encounter any other issue with the update (for example, if a manual refresh of the page shows no progress for an extended period of time), do 
      not restart the update. Instead, contact Support. 
       
       
 
      
 
     
 
     [bookmark: pgfId-8138822]When the update completes, the appliance displays a success message and reboots. After the appliance finishes rebooting, refresh the page to log in and complete any required post-update steps.
 
    
 
   
 
    
     [bookmark: pgfId-8138835][bookmark: 64693]Uninstalling Software[bookmark: marker-8138834] Updates
 
    [bookmark: pgfId-8025522]License: Any
 
    [bookmark: pgfId-7725681]When you apply a patch or feature update to a Cisco appliance, the update process creates an uninstaller that allows you to remove the update from that appliance, using its web interface.
 
    [bookmark: pgfId-8139014]When you uninstall an update, the resulting Cisco software version depends on the update path for your appliance. For example, consider a scenario where you updated an appliance directly from Version 5.0 to Version 5.0.0.2. Uninstalling the Version 5.0.0.2 patch might result in an appliance running Version 5.0.0.1, even though you never installed the Version 5.0.0.1 update. For information on the resulting Cisco software version when you uninstall an update, see the release notes.
 
     
      
    
 
    
 
    [bookmark: pgfId-8085235]Note Uninstalling from the web interface is not supported for major updates. If you updated your appliance to a new major version of the FireSIGHT System and you need to revert to an older version, contact Support.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8083578][bookmark: 23491]Order of Uninstallation
 
    [bookmark: pgfId-8083580]Uninstall the update in the reverse order that you installed it. That is, first uninstall the update from managed devices, then from Defense Centers.
 
    [bookmark: pgfId-8138941]Use the Local Web Interface to Uninstall the Update 
 
    [bookmark: pgfId-8138981]You must use the local web interface to uninstall updates; you cannot use the Defense Center to uninstall updates from managed devices. For information on uninstalling a patch from a device that does not have a local web interface (for example, virtual devices or Cisco NGIPS for Blue Coat X-Series), see the release notes.
 
    [bookmark: pgfId-8179139]Note that, although you can use this process to uninstall minor updates for Cisco NGIPS for Blue Coat X-Series, you cannot use this process to uninstall the Cisco NGIPS for Blue Coat X-Series application from the X-Series platform. For more information, see the Cisco NGIPS for Blue Coat X-Series Installation Guide.
 
    [bookmark: pgfId-8083585][bookmark: 82308]Uninstalling the Update from Clustered or Paired Appliances
 
    [bookmark: pgfId-8084103]Clustered devices and Defense Centers in high availability pairs must run the same version of the FireSIGHT System. Although the uninstallation process triggers an automatic failover, appliances in mismatched pairs or clusters do not share configuration information, nor do they install or uninstall updates as part of their synchronization. If you need to uninstall an update from redundant appliances, plan to perform the uninstallations in immediate succession.
 
    [bookmark: pgfId-8168914]You cannot uninstall an update from devices in a clustered stack if uninstalling would revert these devices to a version in which clustered stacking is not supported.
 
    [bookmark: pgfId-8083828]To ensure continuity of operations, uninstall the update from clustered devices and paired Defense Centers one at a time. First, uninstall the update from the secondary appliance. Wait until the uninstallation process completes, then immediately uninstall the update from the primary appliance.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8135937] 
     Caution If the uninstallation process on a clustered device or paired Defense Center fails, do 
     not restart the uninstall or change configurations on its peer. Instead, contact Support. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8135941]Uninstalling the Update from Stacked Devices
 
    [bookmark: pgfId-8141758]All devices in a stack must run the same version of the FireSIGHT System. Uninstalling the update from any of the stacked devices causes the devices in that stack to enter a limited, mixed-version state.
 
    [bookmark: pgfId-8142901]To minimize impact on your deployment, Cisco recommends that you uninstall an update from stacked devices simultaneously. The stack resumes normal operation when the update completes on all devices in the stack.
 
    [bookmark: pgfId-8169128]You cannot uninstall an update from devices in a clustered stack if uninstalling would revert these devices to a version in which clustered stacking is not supported.
 
    [bookmark: pgfId-8135971][bookmark: 56105]Traffic Flow and Inspection
 
    [bookmark: pgfId-8135942]Uninstalling an update from managed devices may affect traffic inspection, traffic flow, and link state. For specific information on how and when network traffic is affected for a particular update, see the release notes.
 
    [bookmark: pgfId-8178569][bookmark: 57869]After the Uninstallation
 
    [bookmark: pgfId-8178570]After you uninstall the update, there are several steps you should take to ensure that your deployment is performing properly. These include verifying that the uninstall succeeded and that all appliances in your deployment are communicating successfully. For specific information for each update, see the release notes.
 
    [bookmark: pgfId-2560996]To uninstall a patch or feature update using the local web interface:
 
    [bookmark: pgfId-6955876]Access: Admin
 
    
 
    [bookmark: pgfId-2561000]Step 1 Select System > Updates.
 
    [bookmark: pgfId-7732963]The Product Updates page appears.
 
    [bookmark: pgfId-7732964]Step 2 Click the install icon next to the uninstaller for the update you want to remove.
 
     
      
      	 [bookmark: pgfId-7733520]On the Defense Center, the Install Update page appears. Select the Defense Center and click  Install . 
 
      	 [bookmark: pgfId-7733022]On a managed device, there is no intervening page. 
 
     
 
    
 
    [bookmark: pgfId-8084029]In either case, if prompted, confirm that you want to uninstall the update and reboot the appliance. 
 
    [bookmark: pgfId-8084030]The uninstall process begins. You can monitor its progress in the task queue (System > Monitoring > Task Status).
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8043038] 
     Caution Do 
     not use the web interface to perform tasks other than monitoring the update until the uninstall has completed and, if necessary, the appliance reboots. For more information, see 
     Using the Web Interface During the Update. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7729271]Step 3 After the uninstall finishes, if necessary, log into the appliance.
 
    [bookmark: pgfId-8038722]Step 4 Clear your browser cache and force a reload of the browser. Otherwise, the user interface may exhibit unexpected behavior.
 
    [bookmark: pgfId-8038723]Step 5 Select Help > About and confirm that the software version is listed correctly.
 
    [bookmark: pgfId-8038724]Step 6 Verify that the appliance where you uninstalled the patch is successfully communicating with its managed devices (for the Defense Center) or its managing Defense Center (for managed devices).
 
    [bookmark: pgfId-8202846]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-8025560][bookmark: 75380]Updating the Vulne[bookmark: marker-8075892]rability Databa[bookmark: marker-8025559]se
 
    [bookmark: pgfId-8025568]License: Any
 
    [bookmark: pgfId-8025572]The Cisco Vulnerability Database (VDB) is a database of known vulnerabilities to which hosts may be susceptible, as well as fingerprints for operating systems, clients, and applications. The FireSIGHT System correlates the fingerprints with the vulnerabilities to help you determine whether a particular host increases your risk of network compromise. The Cisco Vulnerability Research Team (VRT) issues periodic updates to the VDB.
 
    [bookmark: pgfId-8025582]To update the VDB, use the Product Updates page on the Defense Center. When you upload VDB updates obtained from Support to your appliance, they appear on the page along with updates and uninstaller updates for the FireSIGHT System.
 
    [bookmark: pgfId-8025613]The time it takes to update vulnerability mappings depends on the number of hosts in your network map. You may want to schedule the update during low system usage times to minimize the impact of any system downtime. As a rule of thumb, divide the number of hosts on your network by 1000 to determine the approximate number of minutes to perform the update.
 
     
      
    
 
    
 
    [bookmark: pgfId-8256261]Note Updated application detectors and operating system fingerprints in the VDB require that you reapply access control policies before they can take effect. After you complete a VDB update, reapply any out-of-date access control policies to your managed devices. For more information, see Applying an Access Control Policy.
 
     
     
 
    
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8256278] 
     Caution Installing a VDB update restarts the Snort process when you apply your access control policy, temporarily interrupting traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     How Snort Restarts Affect Traffic and 
     Updating the Vulnerability Database for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8256265]This section explains how to plan for and perform manual VDB updates. You can take advantage of the automated update feature to schedule VDB updates; see Automating Vulnerability Database Updates.
 
    [bookmark: pgfId-8025621]To update the vulnerability database:
 
    [bookmark: pgfId-8025622]Access: Admin
 
    
 
    [bookmark: pgfId-8025623]Step 1 Read the VDB Update Advisory Text for the update.
 
    [bookmark: pgfId-8025624]The advisory text includes information about the changes to the VDB made in the update, as well as product compatibility information.
 
    [bookmark: pgfId-8025625]Step 2 Select System > Updates.
 
    [bookmark: pgfId-8025626]The Product Updates page appears.
 
    [bookmark: pgfId-8025630]Step 3 Upload the update to the Defense Center:
 
     
      
      	 [bookmark: pgfId-8025634]If your Defense Center has access to the Internet, click  Download Updates  to check for the latest updates one either of the following Support Sites: 
 
     
 
    
 
    [bookmark: pgfId-8209231] – Sourcefire: (https://support.sourcefire.com/)
 
    [bookmark: pgfId-8209179] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
     
      
      	 [bookmark: pgfId-8203365]If your Defense Center does not have access to the Internet, manually download the update from one of the following Support Sites, then click  Upload Update . Browse to the update and click  Upload :
 
     
 
    
 
    [bookmark: pgfId-8209589] – Sourcefire: (https://support.sourcefire.com/)
 
    [bookmark: pgfId-8209584] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
     
      
    
 
    
 
    [bookmark: pgfId-8203374]Note Download the update directly from the Support Site either manually or by clicking Download Updates. If you transfer an update file by email, it may become corrupted.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8043272]The update is uploaded to the Defense Center.
 
    [bookmark: pgfId-8043266]Step 4 Click the install icon next to the VDB update.
 
    [bookmark: pgfId-8043267]The Install Update page appears.
 
    [bookmark: pgfId-8043327]Step 5 Select the Defense Center, then click Install.
 
    [bookmark: pgfId-8043328]The update process begins. Depending on the number of hosts in your network map, installing the update may take some time. You can monitor the update's progress in the task queue (System > Monitoring > Task Status).
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8025655] 
     Caution Do 
     not use the web interface to perform tasks related to mapped vulnerabilities until the update has completed. If you encounter issues with the update (for example, if the task queue indicates that the update has failed or if a manual refresh of the task queue shows no progress) 
     do not restart the update. Instead, contact Support. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8025656]Step 6 After the update finishes, select Help > About to confirm that the VDB build number matches the update you installed.
 
    [bookmark: pgfId-8232552]You must reapply any out-of-date access control policies for the VDB update to take effect; see Applying an Access Control Policy.
 
    [bookmark: pgfId-8202808]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7762995][bookmark: 25091]Importing Rule Upd[bookmark: marker-8075897]ates and Loca[bookmark: marker-7762994]l Rule Files
 
    [bookmark: pgfId-8025687]License: Any
 
    [bookmark: pgfId-8225690]As new vulnerabilities become known, the Cisco Vulnerability Research Team (VRT) releases rule updates that you can first import onto your Defense Center, then implement by applying affected access control, network analysis, and intrusion policies to your managed devices.
 
    [bookmark: pgfId-8239503]Rule updates are cumulative, and Cisco recommends you always import the latest update. You cannot import a rule update that either matches or predates the version of the currently installed rules. If your deployment includes a high availability pair of Defense Centers, import the update on the primary only. The secondary Defense Center receives the rule update as part of the regular synchronization process.
 
     
      
    
 
    
 
    [bookmark: pgfId-8239510]Note Rule updates may contain new binaries, so make sure your process for downloading and installing them complies with your security policies. In addition, rule updates may be large, so import rules during periods of low network use.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8221216]A rule update may provide the following:
 
     
     	 [bookmark: pgfId-8221218] new and modified rules and rule states —Rule updates provide new and updated intrusion and preprocessor rules. For new rules, the rule state may be different in each system-provided intrusion policy. For example, a new rule may be enabled in the Security over Connectivity intrusion policy and disabled in the Connectivity over Security intrusion policy. Rule updates may also change the default state of existing rules, or delete existing rules entirely.
 
     	 [bookmark: pgfId-8238971] new rule categories —Rule updates may include new rule categories, which are always added.
 
     	 [bookmark: pgfId-8238972] modified preprocessor and advanced settings —Rule updates may change the advanced settings in the system-provided intrusion policies and the preprocessor settings in system-provided network analysis policies. They can also update default values for the advanced preprocessing and performance options in your access control policies.
 
     	 [bookmark: pgfId-8223170] new and modified variables —Rule updates may modify default values for existing default variables, but do not override your changes. New variables are always added.
 
    
 
    [bookmark: pgfId-8239205]Understanding When Rule Updates Modify Policies
 
    [bookmark: pgfId-8239615]Rule updates can affect both system-provided and custom network analysis policies, as well as all access control policies:
 
     
     	 [bookmark: pgfId-8226316] system provided —Changes to system-provided network analysis and intrusion policies, as well as any changes to advanced access control settings, automatically take effect when you reapply the policies after the update.
 
     	 [bookmark: pgfId-8226445] custom —Because every custom network analysis and intrusion policy uses a system-provided policy as its base, or as the eventual base in a policy chain, rule updates can affect custom network analysis and intrusion policies. However, you can prevent rule updates from automatically making those changes. This allows you to update system-provided base policies manually, on a schedule independent of rule update imports. Regardless of your choice (implemented on a per-custom-policy basis), updates to system-provided policies do  not override any settings you customized. For more information, see Allowing Rule Updates to Modify a System-Provided Base Policy.
 
    
 
    [bookmark: pgfId-8244397]Note that importing a rule update discards all cached changes to network analysis and intrusion policies. For your convenience, the Rule Updates page lists policies with cached changes and the users who made those changes. For more information, see Resolving Conflicts and Committing Policy Changes.
 
    [bookmark: pgfId-8238885]Reapplying Policies
 
    [bookmark: pgfId-8230572]For changes made by a rule update to take affect, you must reapply any modified policies. When importing a rule update, you can configure the system to automatically reapply intrusion or access control policies to their target devices. This is especially useful if you allow the rule update to modify system-provided base policies.
 
     
     	 [bookmark: pgfId-8242418]Reapplying an access control policy also reapplies associated SSL, network analysis, and file policies, but does  not reapply intrusion policies. It also updates the default values for any modified advanced settings. Because you cannot apply a network analysis policy independently, you  must reapply access control policies if you want to update preprocessor settings in network analysis policies.
 
     	 [bookmark: pgfId-8242585]Reapplying intrusion policies allows you to update rules and other changed intrusion policy settings. You can reapply intrusion policies in conjunction with access control policies, or you can apply only intrusion policies to update intrusion rules without updating any other access control configurations.
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-8257299] 
     Caution When you apply an access control or intrusion policy, resource demands may result in a small number of packets dropping without inspection. Additionally, applying some configurations requires the Snort process to restart. This includes applying an access control or intrusion policy after importing an intrusion rule update that includes a new or updated shared object rule. Restarting the Snort process temporarily interrupts traffic inspection. Whether traffic drops during this interruption or passes without further inspection depends on the model of the managed device and how it handles traffic. See 
     Configurations that Restart the Snort Process and 
     How Snort Restarts Affect Traffic for more information. 
      
      
 
     
 
    
 
    [bookmark: pgfId-8058872]For more information on importing rule updates, see:
 
     
     	 [bookmark: pgfId-8058775]Using One-Time Rule Updates explains how to import a single rule update from the Support Site.
 
     	 [bookmark: pgfId-8058786]Using Recurring Rule Updates explains how to use an automated feature on the web interface to download and install rule updates from the Support Site.
 
     	 [bookmark: pgfId-8080020]Importing Local Rule Files explains how to import a copy of a standard text rules file that you have created on a local machine. 
 
     	 [bookmark: pgfId-8080071]Viewing the Rule Update Log explains the rule update log.
 
    
 
     
      [bookmark: pgfId-8058806][bookmark: 64286]Using One-Time Rule Updates
 
     [bookmark: pgfId-8025789]License: Any
 
     [bookmark: pgfId-7763291]There are two methods that you can use for one-time rule updates:
 
      
      	 [bookmark: pgfId-7763295]Using Manual One-Time Rule Updates explains how to manually download a rule update from the Support Site to your local machine and then manually install the rule update.
 
      	 [bookmark: pgfId-7889313]Using Automatic One-Time Rule Updates explains how to use an automated feature on the web interface to search the Support Site for new rule updates and upload them.
 
     
 
    
 
     
      [bookmark: pgfId-7889325][bookmark: 13906]Using Manual One-Time Rule Updates[bookmark: marker-7889324]
 
     [bookmark: pgfId-8025807]License: Any
 
     [bookmark: pgfId-7763328]The following procedure explains how to import a new rule update manually. This procedure is especially useful if your Defense Center does not have Internet access.
 
     [bookmark: pgfId-7763338]To manually import a rule update:
 
     [bookmark: pgfId-8056139]Access: Admin
 
     
 
     [bookmark: pgfId-8041256]Step 1 From a computer that can access the Internet, access either of the following sites:
 
      
       
       	 [bookmark: pgfId-8209316] Sourcefire: ( https://support.sourcefire.com/ )
 
       	 [bookmark: pgfId-8209292] Cisco: ( http://www.cisco.com/cisco/web/support/index.html )
 
      
 
     
 
     [bookmark: pgfId-7763345]Step 2 Click Download, then click Rules.
 
     [bookmark: pgfId-8225821]Step 3 Navigate to the latest rule update.
 
     [bookmark: pgfId-8225832]Rule updates are cumulative; you cannot import a rule update that either matches or predates the version of the currently installed rules.
 
     [bookmark: pgfId-8225823]Step 4 Click the rule update file that you want to download and save it to your computer.
 
     [bookmark: pgfId-8225825]Step 5 [bookmark: 89805]Log into your appliance’s web interface.
 
     [bookmark: pgfId-8025831]Step 6 Select System > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8227906]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8227907]Tip You can also click Import Rules on the Rule Editor page (Policies > Intrusion > Rule Editor).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8227908]Step 7 Optionally, click Delete All Local Rules, then click OK to move all user-defined rules that you have created or imported to the deleted folder. See Deleting Custom Rules for more information.
 
     [bookmark: pgfId-8227371]Step 8 Select Rule Update or text rule file to upload and install and click Choose File to navigate to and select the rule update file.
 
     [bookmark: pgfId-8227374]Step 9 Optionally, reapply policies to your managed devices after the update completes:
 
      
      	 [bookmark: pgfId-8243242]Select  Reapply intrusion policies after the rule update import completes to automatically reapply intrusion policies. Choose only this option to update rules and other changed intrusion policy settings without having to update any other access control configurations you may have made. You  must select this option to reapply intrusion policies in conjunction with access control policies; reapplying access control policies in this case does not perform a complete apply.
 
      	 [bookmark: pgfId-8242871]Select  Reapply access control policies after the rule update import completes to automatically reapply access control policies and their associated SSL, network analysis, and file policies, but not intrusion policies. Selecting this option also updates the default values for any modified access control advanced settings. Because you cannot apply a network analysis policy independently of its parent access control policy, you  must reapply access control policies if you want to update preprocessor settings in network analysis policies.
 
     
 
     [bookmark: pgfId-8242872]Step 10 Click Import.
 
     [bookmark: pgfId-8242875]The system installs the rule update and displays the Rule Update Log detailed view; see Understanding the Rule Update Import Log Detailed View. The system also applies policies as you specified in the previous step; see Applying an Access Control Policy and Applying an Intrusion Policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-8216393]Note Contact Support if you receive an error message while installing the rule update.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8202802]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763450][bookmark: 30475]Using Automatic One-Time Rule Updates[bookmark: marker-7763449]
 
     [bookmark: pgfId-8025902]License: Any
 
     [bookmark: pgfId-8069401]The following procedure explains how to import a new rule update by automatically connecting to the Support Site. You can use this procedure only if the appliance has Internet access.
 
     [bookmark: pgfId-8069406]To automatically import a rule update:
 
     [bookmark: pgfId-8069407]Access: Admin
 
     
 
     [bookmark: pgfId-8025918]Step 1 Select System > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8025922]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8227932]Tip You can also click Import Rules on the Rule Editor page (Policies > Intrusion > Rule Editor).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8053351]Step 2 Optionally, click Delete All Local Rules, then click OK to move all user-defined rules that you have created or imported to the deleted folder. See Deleting Custom Rules for more information.
 
     [bookmark: pgfId-7763501]Step 3 Select Download new Rule Update from the Support Site.
 
     [bookmark: pgfId-8227948]Step 4 Optionally, reapply policies to your managed devices after the update completes:
 
      
      	 [bookmark: pgfId-8243374]Select  Reapply intrusion policies after the rule update import completes to automatically reapply intrusion policies. Choose only this option to update rules and other changed intrusion policy settings without having to update any other access control configurations you may have made. You  must select this option to reapply intrusion policies in conjunction with access control policies; reapplying access control policies in this case does not perform a complete apply.
 
      	 [bookmark: pgfId-8243375]Select  Reapply access control policies after the rule update import completes to automatically reapply access control policies and their associated SSL, network analysis, and file policies, but not intrusion policies. Selecting this option also updates the default values for any modified access control advanced settings. Because you cannot apply a network analysis policy independently of its parent access control policy, you  must reapply access control policies if you want to update preprocessor settings in network analysis policies.
 
     
 
     [bookmark: pgfId-8227989]Step 5 Click Import.
 
     [bookmark: pgfId-8227990]The system installs the rule update and displays the Rule Update Log detailed view; see Understanding the Rule Update Import Log Detailed View. The system also applies policies as you specified in the previous step; see Applying an Access Control Policy and Applying an Intrusion Policy.
 
      
       
     
 
     
 
     [bookmark: pgfId-8216373]Note Contact Support if you receive an error message while installing the rule update.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8202786]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763541][bookmark: 43355]Using Recurring Rule Updates[bookmark: marker-7763540]
 
     [bookmark: pgfId-8025994]License: Any
 
     [bookmark: pgfId-7763552]You can import rule updates on a daily, weekly, or monthly basis, using the Rule Updates page. If your deployment includes a high availability pair of Defense Centers, import the update on the primary only. The secondary Defense Center receives the rule update as part of the regular synchronization process.
 
     [bookmark: pgfId-8228287]Applicable subtasks in the rule update import occur in the following order: download, install, base policy update, and policy reapply. When one subtask completes, the next subtask begins. Note that you can only apply policies previously applied by the appliance where the recurring import is configured.
 
     [bookmark: pgfId-7763571]To schedule recurring rule updates:
 
     [bookmark: pgfId-8056189]Access: Admin
 
     
 
     [bookmark: pgfId-8040378]Step 1 Select System > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8040360]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8228045]Tip You can also click Import Rules on the Rule Editor page (Policies > Intrusion > Rule Editor).
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8053324]Step 2 Optionally, click Delete All Local Rules, then click OK to move all user-defined rules that you have created or imported to the deleted folder. See Deleting Custom Rules for more information.
 
     [bookmark: pgfId-8053331]Step 3 Select Enable Recurring Rule Update Imports.
 
     [bookmark: pgfId-7835066]The page expands to display options for configuring recurring imports. Import status messages appear beneath the Recurring Rule Update Imports section heading. Recurring imports are enabled when you save your settings.
 
      
       
     
 
     
 
     [bookmark: pgfId-7763620]Tip To disable recurring imports, clear the Enable Recurring Rule Update Imports check box and click Save.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7763621]Step 4 In the Import Frequency field, select Daily, Weekly, or Monthly from the drop-down list.
 
     [bookmark: pgfId-7763622]If you selected a weekly or monthly import frequency, use the drop-down lists that appear to select the day of the week or month when you want to import rule updates. Select from a recurring task drop-down list either by clicking or by typing the first letter or number of your selection one or more times and pressing Enter.
 
     [bookmark: pgfId-7763634]Step 5 In the Import Frequency field, specify the time when you want to start your recurring rule update import.
 
     [bookmark: pgfId-8228224]Step 6 Optionally, reapply policies to your managed devices after the update completes:
 
      
      	 [bookmark: pgfId-8243402]Select  Reapply intrusion policies after the rule update import completes to automatically reapply intrusion policies. Choose only this option to update rules and other changed intrusion policy settings without having to update any other access control configurations you may have made. You  must select this option to reapply intrusion policies in conjunction with access control policies; reapplying access control policies in this case does not perform a complete apply.
 
      	 [bookmark: pgfId-8243403]Select  Reapply access control policies after the rule update import completes to automatically reapply access control policies and their associated SSL, network analysis, and file policies, but not intrusion policies. Selecting this option also updates the default values for any modified access control advanced settings. Because you cannot apply a network analysis policy independently of its parent access control policy, you  must reapply access control policies if you want to update preprocessor settings in network analysis policies.
 
     
 
     [bookmark: pgfId-7763647]Step 7 Click Save to enable recurring rule update imports using your settings.
 
     [bookmark: pgfId-7763651]The status message under the Recurring Rule Update Imports section heading changes to indicate that the rule update has not yet run. At the scheduled time, the system installs the rule update and applies policies as you specified in the previous step; see Applying an Access Control Policy and Applying an Intrusion Policy.
 ), and you can view messages as they occur in the Rule Update Log detailed view. Depending on the rule update size and content, several minutes may pass before status messages appear. For more information, see 
     Viewing the Rule Update Log. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-7763695]Note Contact Support if you receive an error message while installing the rule update.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8202763]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763701][bookmark: 76591]Importing Local[bookmark: marker-7763700] Rule Files
 
     [bookmark: pgfId-8026123]License: Any
 
     [bookmark: pgfId-7832209]A local rule is a custom standard text rule that you import from a local machine as a plain text file with ASCII or UTF-8 encoding. You can create local rules using the instructions in the Snort users manual, which is available at http://www.snort.org.
 
     [bookmark: pgfId-7763711]Note the following regarding importing local rules:
 
      
      	 [bookmark: pgfId-7763712]The text file name can include alphanumeric characters, spaces, and no special characters other than underscore ( _ ), period ( . ), and dash ( - ).
 
      	 [bookmark: pgfId-8175133]You do not have to specify a Generator ID (GID); if you do, you can specify only GID 1 for a standard text rule or 138 for a sensitive data rule.
 
      	 [bookmark: pgfId-7768440]Do  not specify a Snort ID (SID) or revision number when importing a rule for the first time; this avoids collisions with SIDs of other rules, including deleted rules.
 
     
 
     [bookmark: pgfId-7763716]The system will automatically assign the rule the next available custom rule SID of 1000000 or greater, and a revision number of 1.
 
      
      	 [bookmark: pgfId-7763720]You  must include the SID assigned by the system and a revision number greater than the current revision number when importing an updated version of a local rule that you have previously imported.
 
     
 
     [bookmark: pgfId-8026128]To view the revision number for a current local rule, display the Rule Editor page (Policies > Intrusion > Rule Editor), click on the local rule category to expand the folder, then click Edit next to the rule.
 
      
      	 [bookmark: pgfId-7763725]You can reinstate a local rule that you have deleted by importing the rule using the SID assigned by the system and a revision number greater than the current revision number. Note that the system automatically increments the revision number when you delete a local rule; this is a device that allows you to reinstate local rules.
 
     
 
     [bookmark: pgfId-8026136]To view the revision number for a deleted local rule, display the Rule Editor page (Policies > Intrusion > Rule Editor), click on the deleted rule category to expand the folder, then click Edit next to the rule.
 
      
      	 [bookmark: pgfId-8143355]You cannot import a rule file that includes a rule with a SID greater than 2147483647; the import will fail.
 
      	 [bookmark: pgfId-8143547]If you import a rule that includes a list of source or destination ports that is longer than 64 characters, the import will fail.
 
      	 [bookmark: pgfId-8143356]The system always sets local rules that you import to the disabled rule state; you must manually set the state of local rules before you can use them in your intrusion policy. See Setting Rule States for more information.
 
      	 [bookmark: pgfId-7763747]You must make sure that the rules in the file do not contain any escape characters.
 
      	 [bookmark: pgfId-7832231]The rules importer requires that all custom rules are imported in ASCII or UTF-8 encoding.
 
      	 [bookmark: pgfId-7763748]All imported local rules are automatically saved in the local rule category.
 
      	 [bookmark: pgfId-8026144]All deleted local rules are moved from the local rule category to the deleted rule category.
 
      	 [bookmark: pgfId-7763753]The system imports local rules preceded with a single pound character (#), but they are flagged as deleted.
 
      	 [bookmark: pgfId-8002676]The system ignores local rules preceded with two pound characters (##) and does not import them.
 
      	 [bookmark: pgfId-8171732]Cisco strongly recommends that you import local rules on the primary Defense Center in a High Availability Pair to avoid SID numbering issues.
 
      	 [bookmark: pgfId-8002678]Policy validation fails if you enable an imported local rule that uses the deprecated  threshold keyword in combination with the intrusion event thresholding feature in an intrusion policy. See Configuring Event Thresholding for more information.
 
     
 
     [bookmark: pgfId-7763762]To import local rule files:
 
     [bookmark: pgfId-8056209]Access: Admin
 
     
 
     [bookmark: pgfId-8026152]Step 1 Select Policies > Intrusion > Rule Editor.
 
     [bookmark: pgfId-8026153]The Rule Editor page appears.
 
     [bookmark: pgfId-8070310]Step 2 Click Import Rules.
 
     [bookmark: pgfId-8070311]The Import Rules page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8218812]Tip You can also select System > Updates, then select the Rule Updates tab.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8218813]Step 3 Select Rule Update or text rule file to upload and install and click Browse to navigate to your rule file. Note that all rules uploaded in this manner are saved in the local rule category.
 
      
       
     
 
     
 
     [bookmark: pgfId-8218846]Tip You can import only plain text files with ASCII or UTF-8 encoding.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-7763795]Step 4 Click Import.
 
     [bookmark: pgfId-7763796]The rule file is imported. Make sure you enable the appropriate rules in your intrusion policies. The rules are not activated until the next time you apply the affected policies. 
 
      
       
     
 
     
 
     [bookmark: pgfId-7763800]Note Managed devices do not use the new rule set for inspection until after you apply their intrusion policies. See Applying an Access Control Policy for procedures.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8202736]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763810][bookmark: 45056]Viewing th[bookmark: marker-7763805]e Rule Update Log
 
     [bookmark: pgfId-8026197]License: Any
 
     [bookmark: pgfId-7763828]The Defense Center generates a record for each rule update and local rule file that you import.
 
      
      
 
      [bookmark: pgfId-8080775] 
      
 
      
 
       
        
        [bookmark: pgfId-8080754]Table 66-2 [bookmark: 62720]Rule Update Log Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-8080758]To... 
          
  
         	 
           
           [bookmark: pgfId-8080760]You can... 
          
  
        
 
         
         	[bookmark: pgfId-8080762]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-8080766]find more information in Understanding the Rule Update Log Table.
  
        
 
         
         	[bookmark: pgfId-8080769]delete an import file record from the import log, including detailed records for all objects included with the file
  ) next to the file name for the import file. Note Deleting the file from the log does not delete any object imported in the import file, but only deletes the import log records. 
        
 
         
         	[bookmark: pgfId-8080777]view details for each object imported in a rule update or local rule file
  ) next to the file name for the import file. 
        
 
        
      
 
     
 
     [bookmark: pgfId-8080784]See the following sections for more information:
 
      
      	 [bookmark: pgfId-8080920]Understanding the Rule Update Log Table describes the fields in the list of rule updates and local rule files that you import.
 
      	 [bookmark: pgfId-8080957]Viewing Rule Update Import Log Details describes the detailed record for each object imported in a rule update or local rule file.
 
      	 [bookmark: pgfId-8080972]Understanding the Rule Update Import Log Detailed View describes each field in the Rule Update Log detailed view.
 
      	 [bookmark: pgfId-8080987]Searching the Rule Update Import Log explains how you can search the import log for specific records or for all records matching the search criteria.
 
     
 
     [bookmark: pgfId-8080786]To view the Rule Update Log:
 
     [bookmark: pgfId-8056224]Access: Admin
 
     
 
     [bookmark: pgfId-8056672]Step 1 Select System > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8070484]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8070489]Tip You can also click Import Rules on the Rule Editor page, which you access by selecting Policies > Intrusion > Rule Editor.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8070394]Step 2 Click Rule Update Log.
 
     [bookmark: pgfId-8068989]The Rule Update Log page appears. This page lists each imported rule update and local rule file.
 
     [bookmark: pgfId-8202709]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-7763903][bookmark: 64770]Unders[bookmark: marker-7763899]tanding the Rule Update Log Table
 
     [bookmark: pgfId-8026246]License: Any
 
     [bookmark: pgfId-8071166]The fields in the list of rule updates and local rule files that you import are described in the following table.
 
     [bookmark: pgfId-8071225]
 
      
       
        
        [bookmark: pgfId-8071179]Table 66-3 [bookmark: 68046]Rule Update Log Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-8071183]Field 
          
  
         	 
           
           [bookmark: pgfId-8071185]Description 
          
  
        
 
         
         	[bookmark: pgfId-8071187]Summary
  
         	[bookmark: pgfId-8071189]The name of the import file. If the import fails, a brief statement of the reason for the failure appears under the file name.
  
        
 
         
         	[bookmark: pgfId-8071191]Time
  
         	[bookmark: pgfId-8071193]The time and date that the import started.
  
        
 
         
         	[bookmark: pgfId-8071195]User ID
  
         	[bookmark: pgfId-8071197]The user name of the user that triggered the import.
  
        
 
         
         	[bookmark: pgfId-8071199]Status
  
         	[bookmark: pgfId-8071201]Whether the import:
 
           
           	 [bookmark: pgfId-8071205]succeeded (
 
           [image: ] ) 
          
 
           
           	 [bookmark: pgfId-8071209]failed or is currently in progress (
 
           [image: ] ) 
          
 [bookmark: pgfId-8071210]Tip The red status icon indicating an unsuccessful or incomplete import appears on the Rule Update Log page during the import and is replaced by the green icon only when the import has successfully completed.  
        
 
        
      
 
     
 ) to delete the file record and all detailed object records imported with the file. 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-8071232]Tip You can view import details as they appear while a rule update import is in progress.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8071241][bookmark: 19390]Viewing Rule Update Import Log Details
 
     [bookmark: pgfId-8026264]License: Any
 
     [bookmark: pgfId-8026273]The Rule Update Import Log detailed view lists a detailed record for each object imported in a rule update or local rule file. You can also create a custom workflow or report from the records listed that includes only the information that matches your specific needs.
 
      
       
        
        [bookmark: pgfId-8026294]Table 66-4 [bookmark: 48634]Rule Update Import Log Detailed View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-8026298]To... 
          
  
         	 
           
           [bookmark: pgfId-8026300]You can... 
          
  
        
 
         
         	[bookmark: pgfId-8026302]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-8026306]find more information in Understanding the Rule Update Import Log Detailed View.
  
        
 
         
         	[bookmark: pgfId-8026309]sort and constrain records on the current workflow page
  
         	[bookmark: pgfId-8026313]find more information in Sorting Drill-Down Workflow Pages.
  
        
 
         
         	[bookmark: pgfId-8026330]temporarily use a different workflow
  
         	[bookmark: pgfId-8026332]click (switch workflows). For information on selecting workflows, see Selecting Workflows. For information on creating custom workflows, see Creating Custom Workflows.
  
        
 
         
         	[bookmark: pgfId-8026340]bookmark the current page so that you can quickly return to it
  
         	[bookmark: pgfId-8026342]click Bookmark This Page. For more information, see Using Bookmarks.
  
        
 
         
         	[bookmark: pgfId-8026347]navigate to the bookmark management page
  
         	[bookmark: pgfId-8026349]click View Bookmarks. For more information, see Using Bookmarks.
  
        
 
         
         	[bookmark: pgfId-8026354]generate a report based on the data in the current view
  
         	[bookmark: pgfId-8026356]click Report Designer. For more information, see Creating a Report Template from an Event View.
  
        
 
         
         	[bookmark: pgfId-8026364]search the entire Rule Update Import Log database for rule update import records
  
         	[bookmark: pgfId-8026369]click Search. From more information, see Searching the Rule Update Import Log.
  
        
 
         
         	[bookmark: pgfId-8026374]open a search page prepopulated with the current single constraint
  
         	[bookmark: pgfId-8026376]select Edit Search or Save Search next to Search Constraints. From more information, see the Table View and Drill-Down Page Features table.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7764100]To view the Rule Update Import Log Detailed View:
 
     [bookmark: pgfId-8081682]Access: Admin
 
     
 
     [bookmark: pgfId-8081683]Step 1 Select System > Updates, then select the Rule Updates tab.
 
     [bookmark: pgfId-8081684]The Rule Updates page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-8071667]Tip You can also click Import Rules on the Rule Editor page, which you access by selecting Policies > Intrusion > Rule Editor.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8071668]Step 2 Click Rule Update Log.
 
     [bookmark: pgfId-8071669]The Rule Update Log page appears.
 ) next to the file whose detailed records you want to view. 
     
 
     [bookmark: pgfId-7764118]The table view of detailed records appears.
 
     [bookmark: pgfId-8202691]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-8026414][bookmark: 88409]Understand[bookmark: marker-8026410]ing the Rule Update Import Log Detailed View
 
     [bookmark: pgfId-8026428]License: Any
 
     [bookmark: pgfId-8071790]You can view a detailed record for each object imported in a rule update or local rule file. The fields in the Rule Update Log detailed view are described in the following table.
 
     [bookmark: pgfId-8026561]
 
      
       
        
        [bookmark: pgfId-8026448]Table 66-5 [bookmark: 88968]Rule Update Import Log Detailed View Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-8026452]Field 
          
  
         	 
           
           [bookmark: pgfId-8026454]Description 
          
  
        
 
         
         	[bookmark: pgfId-8026456]Time
  
         	[bookmark: pgfId-8026458]The time and date the import began.
  
        
 
         
         	[bookmark: pgfId-8026460]Name
  
         	[bookmark: pgfId-8026462]The name of the imported object, which for rules corresponds to the rule Message field, and for rule update components is the component name.
  
        
 
         
         	[bookmark: pgfId-8026467]Type
  
         	[bookmark: pgfId-8026472]The type of imported object, which can be one of the following:
 
           
           	 [bookmark: pgfId-8089534] rule update component (an imported component such as a rule pack or policy pack)
 
           	 [bookmark: pgfId-8089535] rule (for rules, a new or updated rule; note that in Version 5.0.1 this value replaced the  update value, which is deprecated)
 
           	 [bookmark: pgfId-8081851] policy apply  (the  Reapply intrusion policies after the Rule Update import completes option was enabled for the import)
 
          
  
        
 
         
         	[bookmark: pgfId-8026477]Action
  
         	[bookmark: pgfId-8026479]An indication that one of the following has occurred for the object type:
 
           
           	 [bookmark: pgfId-8026480] new (for a rule, this is the first time the rule has been stored on this appliance)
 
           	 [bookmark: pgfId-8026487] changed (for a rule update component or rule, the rule update component has been modified, or the rule has a higher revision number and the same GID and SID)
 
           	 [bookmark: pgfId-8026491] collision (for a rule update component or rule, import was skipped because its revision conflicts with an existing component or rule on the appliance)
 
           	 [bookmark: pgfId-8026492] deleted (for rules, the rule has been deleted from the rule update)
 
           	 [bookmark: pgfId-8026499] enabled (for a rule update edit, a preprocessor, rule, or other feature has been enabled in a default policy provided by Cisco)
 
           	 [bookmark: pgfId-8026506] disabled (for rules, the rule has been disabled in a default policy provided by Cisco)
 
           	 [bookmark: pgfId-8026510] drop (for rules, the rule has been set to Drop and Generate Events in a default policy provided by Cisco)
 
           	 [bookmark: pgfId-8026517] error (for a rule update or local rule file, the import failed)
 
           	 [bookmark: pgfId-8081872] apply (the  Reapply intrusion policies after the Rule Update import completes option was enabled for the import)
 
          
  
        
 
         
         	[bookmark: pgfId-8170445]Default Action
  
         	[bookmark: pgfId-8170447]The default action defined by the rule update. When the imported object type is rule, the default action is Pass, Alert, or Drop. For all other imported object types, there is no default action.
  
        
 
         
         	[bookmark: pgfId-8026523]GID
  
         	[bookmark: pgfId-8026528]The generator ID for a rule. For example, 1 (standard text rule) or 3 (shared object rule). See Table 41-7 for more information.
  
        
 
         
         	[bookmark: pgfId-8026536]SID
  
         	[bookmark: pgfId-8026538]The SID for a rule.
  
        
 
         
         	[bookmark: pgfId-8026540]Rev
  
         	[bookmark: pgfId-8026542]The revision number for a rule.
  
        
 
         
         	[bookmark: pgfId-8026544]Policy
  
         	[bookmark: pgfId-8143140]For imported rules, this field displays All, which indicates that the imported rule was included in all default intrusion policies. For other types of imported objects, this field is blank.
  
        
 
         
         	[bookmark: pgfId-8026548]Details
  
         	[bookmark: pgfId-8026550]A string unique to the component or rule. For rules, the GID, SID, and previous revision number for a changed rule, displayed as previously (GID:SID:Rev). This field is blank for a rule that has not changed.
  
        
 
         
         	[bookmark: pgfId-8026552]Count
  
         	[bookmark: pgfId-8026554]The count (1) for each record. The Count field appears in a table view when the table is constrained, and the Rule Update Log detailed view is constrained by default to rule update records.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-7888772][bookmark: 14076]Searching the Rule Update Impor[bookmark: marker-7888771]t Log
 
     [bookmark: pgfId-8026584]License: Any
 
      
       
     
 
     
 
     [bookmark: pgfId-8212712]Note Beta Users: This feature will be fully explained in the final version of the documentation.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8071945]You can search the import log for specific records or for all records matching the search criteria. You may want to create customized searches and save them to reuse later. 
 
      
       
     
 
     
 
     [bookmark: pgfId-8071949]Tip You search the entire Rule Update Import Log database even when you initiate a search by clicking Search on the toolbar from the Rule Update Import Log detailed view with only the records for a single import file displayed. Make sure you set your time constraints to include all objects you want to include in the search. See Specifying Time Constraints in Searches for more information.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-7888813]Table 66-6 [bookmark: 13397]Rule Update Import Log Search Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-7888819]Search Field 
          
  
         	 
           
           [bookmark: pgfId-7888821]Description 
          
  
         	 
           
           [bookmark: pgfId-7888823]Example 
          
  
        
 
         
         	[bookmark: pgfId-7888825]Time
  
         	[bookmark: pgfId-7888827]Specify the date and time the record was generated. See Specifying Time Constraints in Searches for the syntax for entering time.
  
         	[bookmark: pgfId-7888832]> 2006-01-15 13:30:00 returns all rule records imported after January 15, 2006 at 1:30 PM.
  
        
 
         
         	[bookmark: pgfId-7888834]Name
  
         	[bookmark: pgfId-7888836]Specify all or part of the content of the rule Message field. You can use an asterisk (*) as a wildcard character in this field.
  
         	[bookmark: pgfId-7888838]*dhcp* returns all rule records with DHCP in the Message field.
  
        
 
         
         	[bookmark: pgfId-7888840]Type
  
         	[bookmark: pgfId-7888842]Specify the type of record, which can be rule update component, rule, or policy apply.
 [bookmark: pgfId-8089577]Note that you can use the update search value to search for rules imported prior to Version 5.0.1.
  
         	[bookmark: pgfId-7888853]update returns imported rule update components such as a rule pack or policy pack; rule returns rule updates, including new rules; policy apply returns a table row of information for rule updates where intrusion policies were automatically reapplied following the update.
  
        
 
         
         	[bookmark: pgfId-7949682]Action
  
         	[bookmark: pgfId-7949684]Specify an action for the object you want to view. See the Rule Update Import Log Detailed View Fields table for a list of actions you can specify.
  
         	[bookmark: pgfId-7949689]When the type is rule, new returns all rules imported for the first time on the appliance.
  
        
 
         
         	[bookmark: pgfId-7888864]GID
  
         	[bookmark: pgfId-7888866]Specify the generator ID for the rule.
  
         	[bookmark: pgfId-7888871]3 returns all shared object rules.
  
        
 
         
         	[bookmark: pgfId-7888873]SID
  
         	[bookmark: pgfId-7888875]Specify a signature ID or a range of SIDs for a rule.
  
         	[bookmark: pgfId-7888877]923 returns the record for the rule with the SID 923.
  
        
 
         
         	[bookmark: pgfId-7888879]Rev
  
         	[bookmark: pgfId-7888881]Specify the revision number for the rule.
  
         	[bookmark: pgfId-7888883]3 returns rules with the revision number 3.
  
        
 
         
         	[bookmark: pgfId-7888885]Policy
  
         	[bookmark: pgfId-7888887]Specify the default policy the rule is imported into.
  
         	[bookmark: pgfId-7888889]All returns rules imported into all default policies.
  
        
 
         
         	[bookmark: pgfId-7888894]Rule Update
  
         	[bookmark: pgfId-7888899]Specify the Rule Update filename.
  
         	[bookmark: pgfId-7888901]filename returns all records for the specified import file.
  
        
 
         
         	[bookmark: pgfId-7888903]Details
  
         	[bookmark: pgfId-7888905]Specify details on the imported object. 
  
         	[bookmark: pgfId-7888907]previously* returns the record for all rules that have changed.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7888909]For more information on searching, including how to load and delete saved searches, see Searching for Events.
 
     [bookmark: pgfId-7888916]To search the Rule Update Import Log:
 
     [bookmark: pgfId-8072079]Access: Admin/Intrusion Admin
 
     
 
     [bookmark: pgfId-8072094]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-8072095]The Search page appears.
 
     [bookmark: pgfId-8072159]Step 2 From the Table drop-down list, select Rule Update Import Log.
 
     [bookmark: pgfId-8072087]The page reloads with the appropriate constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-8072184]Tip You can also click Search on the Rule Update Log detailed view; see Viewing Rule Update Import Log Details.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-8072173]Step 3 Optionally, if you want to save the search, enter a name for the search in the Name field.
 
     [bookmark: pgfId-7888934]If you do not enter a name, the web interface automatically creates one when you save it.
 
     [bookmark: pgfId-7888937]Step 4 Enter your search criteria in the appropriate fields, as described in the Rule Update Import Log Search Criteria table. If you enter multiple criteria, the search returns the records that match all the criteria.
 
     [bookmark: pgfId-8026613]Step 5 If you want to save the search so that other users can access it, clear the Save As Private check box. Otherwise, leave the check box selected to save the search as private. 
 
     [bookmark: pgfId-8076853]If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
     [bookmark: pgfId-8026624]Step 6 You have the following options:
 
      
       
       	 [bookmark: pgfId-8026625]Click  Search to start the search.
 
      
 
     
 
     [bookmark: pgfId-8026629]Your search results appear in the default Rule Update Import Log detailed view workflow. To use a different workflow, including a custom workflow, click (switch workflows). For information on specifying a different default workflow, see Configuring Event View Settings.
 
      
       
       	 [bookmark: pgfId-8026633]Click  Save if you are modifying an existing search and want to save your changes.
 
       	 [bookmark: pgfId-8026634]Click  Save as New Search to save the search criteria. The search is saved (and associated with your user account if you selected  Save As Private ) so that you can run it at a later time.
 
      
 
     
 
     [bookmark: pgfId-8202679]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-8157403][bookmark: 92136]Updating the [bookmark: marker-8177023]Geolocation Database
 
    [bookmark: pgfId-8194051]License: FireSIGHT
 
    [bookmark: pgfId-8194052]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-8194056]The Cisco Geolocation Database (GeoDB) is a database of geographical data (such as country, city, coordinates, and so on) and connection-related data (such as Internet service provider, domain name, connection type, and so on) associated with routable IP addresses. When your system detects GeoDB information that matches a detected IP address, you can view the geolocation information associated with that IP address. You must install the GeoDB on your system to view any geolocation details other than country or continent. Cisco issues periodic updates to the GeoDB.
 
    [bookmark: pgfId-8158448]To update the GeoDB, use the Geolocation Updates page (System > Updates > Geolocation Updates) on the Defense Center. When you upload GeoDB updates you obtained from Support or from your appliance, they appear on this page.
 
    [bookmark: pgfId-8158811]Time needed to update the GeoDB depends on your appliance; the installation usually takes 30 to 40 minutes. Although a GeoDB update does not interrupt any other system functions (including the ongoing collection of geolocation information), the update does consume system resources while it completes. Consider this when planning your updates.
 
    [bookmark: pgfId-8167707]This section explains how to plan for and perform manual GeoDB updates. You can also take advantage of the automated update feature to schedule GeoDB updates; for more information, see Automating Geolocation Database Updates. For more information on geolocation, see Using Geolocation.
 
    [bookmark: pgfId-8167711]To update the geolocation database:
 
    [bookmark: pgfId-8167712]Access: Admin
 
    
 
    [bookmark: pgfId-8167591]Step 1 Select System > Updates.
 
    [bookmark: pgfId-8167592]The Product Updates page appears.
 
    [bookmark: pgfId-8159814]Step 2 Click the Geolocation Updates tab.
 
    [bookmark: pgfId-8159856]The Geolocation Updates page appears.
 
    [bookmark: pgfId-8159905]Step 3 Upload the update to the Defense Center.
 
     
      
      	 [bookmark: pgfId-8160014]If your Defense Center has access to the Internet, click  Download and install geolocation update from the Support Site  to check for the latest updates on either of the Support Sites:
 
     
 
    
 
    [bookmark: pgfId-8209413] – Sourcefire: (https://support.sourcefire.com/)
 
    [bookmark: pgfId-8209406] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
     
      
      	 [bookmark: pgfId-8160022]If your Defense Center does not have access to the Internet, manually download the update from either of the Support Sites, then click  Upload and install geolocation update . Browse to the update and click  Import :
 
     
 
    
 
    [bookmark: pgfId-8209361] – Sourcefire: (https://support.sourcefire.com/)
 
    [bookmark: pgfId-8209353] – Cisco: (http://www.cisco.com/cisco/web/support/index.html)
 
     
      
    
 
    
 
    [bookmark: pgfId-8160214]Note Download the update directly from the Support Site, either manually or by clicking Download and install geolocation update from the Support Site on the Geolocation Updates page. If you transfer an update file by email, it may become corrupted.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-8160160]The update process begins. The average duration of update installation is 30 to 40 minutes; this may vary depending on your appliance hardware. You can monitor the update’s progress in the task queue (System > Monitoring > Task Status).
 
    [bookmark: pgfId-8160358]Step 4 After the update finishes, return to the Geolocation Updates page or select Help > About to confirm that the GeoDB build number matches the update you installed.
 
    [bookmark: pgfId-8160939]The GeoDB update overrides any previous versions of the GeoDB and is effective immediately. When you update the GeoDB, the Defense Center automatically updates its managed devices. Although it may take a few minutes for a GeoDB update to take effect throughout your deployment, you do not have to reapply access control policies after you update.
 
    [bookmark: pgfId-8202685]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7729185]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3510725][bookmark: 11549]Monitori[bookmark: marker-3510724]ng the System 
      
      
 
     
 
 
    [bookmark: pgfId-3614639]The FireSIGHT System provides many useful monitoring features to assist you in the daily administration of your system, all on a single page. For example, on the Host Statistics page you can monitor basic host statistics and intrusion event information, as well as statistics for the Data Correlator and network discovery processes for the current day. You can also monitor both summary and detailed information on all processes that are currently running on the Defense Center or managed device. The following sections provide more information about the monitoring features that the system provides:
 
     
     	 [bookmark: pgfId-1870447]Viewing Host Statistics describes how to view host information such as:
 
      
      	 [bookmark: pgfId-2187702]system uptime
 
      	 [bookmark: pgfId-2187707]disk and memory usage
 
      	 [bookmark: pgfId-3729565]Data Correlator statistics
 
      	 [bookmark: pgfId-2187724]system processes
 
      	 [bookmark: pgfId-3731042]intrusion event information
 
     
 
     	 [bookmark: pgfId-3731043]On the Defense Center, you can also use the health monitor to monitor disk usage and alert on low disk space conditions. For more information, see Understanding Health Monitoring.
 
     	 [bookmark: pgfId-3862566]Monitoring System Status and Disk Space Usage describes how to view basic event and disk partition information.
 
     	 [bookmark: pgfId-1870490]Viewing System Process Status describes how to view basic process status.
 
     	 [bookmark: pgfId-2187738]Understanding Running Processes describes the basic system processes that run on the appliance.
 
    
 
    [bookmark: pgfId-3862702]You can use the options in Overview > Summary to view and graph statistics for intrusion and discovery events. For more information, see:
 
     
     	 [bookmark: pgfId-3862763]Viewing Intrusion Event Statistics
 
     	 [bookmark: pgfId-3862833]Viewing Intrusion Event Graphs
 
     	 [bookmark: pgfId-3862883]Viewing Discovery Event Statistics
 
     	 [bookmark: pgfId-3862933]Viewing Discovery Performance Graphs
 
    
 
   
 
    
     [bookmark: pgfId-2682497][bookmark: 37283]Viewing[bookmark: marker-3717508] Host Statistics
 
    [bookmark: pgfId-3838141]License: Any
 
    [bookmark: pgfId-3729628]The Statistics page lists the current status of the following:
 
     
     	 [bookmark: pgfId-3729629]general host statistics; see the  Host Statistics  table for details
 
     	 [bookmark: pgfId-3729630]Data Correlator statistics (Defense Center only — requires FireSIGHT); see the  Data Correlator Process Statistics  table for details
 
     	 [bookmark: pgfId-3864492]intrusion event information (requires Protection); see the  Intrusion Event Information  table for details
 
    
 
    [bookmark: pgfId-3897848]The following table describes the host statistics listed on the Statistics page.
 
    [bookmark: pgfId-3739557]
 
     
      
       
       [bookmark: pgfId-3739520]Table 67-1 [bookmark: 88115]Host Statistics 
 
       
       
        
        	 
          
          [bookmark: pgfId-3739524]Category 
         
  
        	 
          
          [bookmark: pgfId-3739526]Description 
         
  
       
 
        
        	[bookmark: pgfId-3739528]Time
  
        	[bookmark: pgfId-3739530]The current time on the system.
  
       
 
        
        	[bookmark: pgfId-3739532]Uptime
  
        	[bookmark: pgfId-3739534]The number of days (if applicable), hours, and minutes since the system was last started.
  
       
 
        
        	[bookmark: pgfId-3739536]Memory Usage
  
        	[bookmark: pgfId-3739538]The percentage of system memory that is being used.
  
       
 
        
        	[bookmark: pgfId-3739540]Load Average
  
        	[bookmark: pgfId-3739542]The average number of processes in the CPU queue for the past 1 minute, 5 minutes, and 15 minutes.
  
       
 
        
        	[bookmark: pgfId-3739544]Disk Usage
  
        	[bookmark: pgfId-3739546]The percentage of the disk that is being used. Click the arrow to view more detailed host statistics. See Monitoring System Status and Disk Space Usage for more information.
  
       
 
        
        	[bookmark: pgfId-3739551]Processes
  
        	[bookmark: pgfId-3739553]A summary of the processes running on the system. See Viewing System Process Status for more information.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3739558]If your FireSIGHT System deployment includes a Defense Center with a FireSIGHT license, you can also view statistics about the Data Correlator and network discovery processes for the current day. As the managed devices perform data acquisition, decoding, and analysis, the network discovery process correlates the data with the fingerprint and vulnerability databases, then produces binary files that are processed by the Data Correlator running on the Defense Center. The Data Correlator analyzes the information from the binary files, generates events, and creates the discovery network map.
 
    [bookmark: pgfId-3739574]The statistics that appear for network discovery and the Data Correlator are averages for the current day, using statistics gathered between 12:00 AM and 11:59 PM for each device. 
 
    [bookmark: pgfId-3739578]The following table describes the statistics displayed for the Data Correlator process.
 
    [bookmark: pgfId-3739630]
 
     
      
       
       [bookmark: pgfId-3739585]Table 67-2 [bookmark: 18275]Data Correlator Process Statistics 
 
       
       
        
        	 
          
          [bookmark: pgfId-3739589]Category 
         
  
        	 
          
          [bookmark: pgfId-3739591]Description 
         
  
       
 
        
        	[bookmark: pgfId-3739593]Events/Sec
  
        	[bookmark: pgfId-3739595]Number of discovery events that the Data Correlator receives and processes per second
  
       
 
        
        	[bookmark: pgfId-3739604]Connections/Sec
  
        	[bookmark: pgfId-3739606]Number of connections that the Data Correlator receives and processes per second
  
       
 
        
        	[bookmark: pgfId-3739615]CPU Usage — User (%)
  
        	[bookmark: pgfId-3739617]Average percentage of CPU time spent on user processes for the current day
  
       
 
        
        	[bookmark: pgfId-3739619]CPU Usage — System (%)
  
        	[bookmark: pgfId-3739621]Average percentage of CPU time spent on system processes for the current day
  
       
 
        
        	[bookmark: pgfId-3739623]VmSize (KB)
  
        	[bookmark: pgfId-3739625]Average size of memory allocated to the Data Correlator for the current day, in kilobytes
  
       
 
        
        	[bookmark: pgfId-3739627]VmRSS (KB)
  
        	[bookmark: pgfId-3739629]Average amount of memory used by the Data Correlator for the current day, in kilobytes
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3864569]On managed devices and on Defense Centers that manage devices, you can also view the date and time of the last intrusion event, the total number of events that have occurred in the past hour and the past day, and the total number of events in the database.
 
     
      
    
 
    
 
    [bookmark: pgfId-3864570]Note The information in the Intrusion Event Information section of the Statistics page is based on intrusion events stored on the managed device rather than those sent to the Defense Center. If you manage your device so that intrusion events are not stored locally, no intrusion event information is listed on this page. This is also the case for managed devices that cannot store events locally.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3864577]The following table describes the statistics displayed in the Intrusion Event Information section of the Statistics page.
 
    [bookmark: pgfId-3864607]
 
     
      
       
       [bookmark: pgfId-3864584]Table 67-3 [bookmark: 19926]Intrusion Event Information 
 
       
       
        
        	 
          
          [bookmark: pgfId-3864588]Statistic 
         
  
        	 
          
          [bookmark: pgfId-3864590]Description 
         
  
       
 
        
        	[bookmark: pgfId-3864592]Last Alert Was
  
        	[bookmark: pgfId-3864594]The date and time that the last event occurred
  
       
 
        
        	[bookmark: pgfId-3864596]Total Events Last Hour 
  
        	[bookmark: pgfId-3864598]The total number of events that occurred in the past hour
  
       
 
        
        	[bookmark: pgfId-3864600]Total Events Last Day 
  
        	[bookmark: pgfId-3864602]The total number of events that occurred in the past twenty-four hours
  
       
 
        
        	[bookmark: pgfId-3864604]Total Events in Database 
  
        	[bookmark: pgfId-3864606]The total number of events in the events database
  
       
 
       
     
 
    
 
    [bookmark: pgfId-3864542]To view the Statistics page:
 
    [bookmark: pgfId-3771457]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3731105]Step 1 Select System > Monitoring > Statistics.
 
    [bookmark: pgfId-3731106]The Statistics page appears.
 
    [bookmark: pgfId-3731129]Step 2 On the Defense Center, you can also list statistics for managed devices. From the Select Device(s) box, click Select Devices. You can use the Shift and Ctrl keys to select multiple devices at once.
 
    [bookmark: pgfId-3731130]The Statistics page is updated with statistics for the devices you selected.
 
    [bookmark: pgfId-3892374]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-2449040][bookmark: 40699]Monitoring System Status and[bookmark: marker-3717509] Disk Space Usage
 
    [bookmark: pgfId-3838174]License: Any
 
    [bookmark: pgfId-1870771]The Disk Usage section of the Statistics page provides a quick synopsis of disk usage, both by category and by partition status. If you have a malware storage pack installed on a device, you can also check its partition status. You can monitor this page from time to time to ensure that enough disk space is available for system processes and the database. 
 
     
      
    
 
    
 
    [bookmark: pgfId-3731319]Tip On the Defense Center, you can also use the health monitor to monitor disk usage and alert on low disk space conditions. For more information, see Understanding Health Monitoring.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1870772]To access disk usage information:
 
    [bookmark: pgfId-3771468]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-1879473]Step 1 Select System > Monitoring > Statistics.
 
    [bookmark: pgfId-2319474]The Statistics page appears. 
 
    [bookmark: pgfId-3883196]Step 2 Hover your pointer over a disk usage category in the By Category stacked bar to view (in order): 
 
     
      
      	 [bookmark: pgfId-3884255]the percentage of available disk space used by that category 
 
      	 [bookmark: pgfId-3884269]the actual storage space on the disk
 
      	 [bookmark: pgfId-3884273]the total disk space available for that category 
 
     
 
    
 
    [bookmark: pgfId-3884294]For more information on the disk usage categories, see Understanding the Disk Usage Widget.
 
    [bookmark: pgfId-1879474]Step 3 Click the down arrow next to Total to expand it.
 
    [bookmark: pgfId-1879480]The Disk Usage section expands, displaying partition usage. If you have a malware storage pack installed, the /var/storage partition usage is also displayed.
 
    [bookmark: pgfId-3859890]If your deployment includes multiple managed devices, you may want to constrain disk usage data by specific devices.
 
    [bookmark: pgfId-3859874]On the Defense Center, to view disk usage information for a specific device:
 
    [bookmark: pgfId-3777969]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3731350]Step 1 Select the device name from the Select Device(s) box, and click Select Devices.
 
    [bookmark: pgfId-3731351]The page reloads, listing host statistics for each device you selected.
 
    [bookmark: pgfId-3731352]Step 2 Click the down arrow next to Disk Usage to expand it.
 
    [bookmark: pgfId-3731353]The Disk Usage section expands.
 
    [bookmark: pgfId-3892380]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1880095][bookmark: 96982][bookmark: 95994]Viewing System Process Status[bookmark: marker-1880094]
 
    [bookmark: pgfId-3838205]License: Any
 
    [bookmark: pgfId-1747404]The Processes section of the Host Statistics page allows you to see the processes that are currently running on an appliance. It provides general process information and specific information for each running process. If you are managing devices with a Defense Center, you can use the Defense Center’s web interface to view the process status for any managed device.
 
    [bookmark: pgfId-3740913]The following table describes each column that appears in the process list.
 
    [bookmark: pgfId-3740968]
 
     
      
       
       [bookmark: pgfId-3741008]Table 67-4 [bookmark: 39796]Process Status 
 
       
       
        
        	 
          
          [bookmark: pgfId-3740916]Column 
         
  
        	 
          
          [bookmark: pgfId-3740918]Description 
         
  
       
 
        
        	[bookmark: pgfId-3740920]Pid
  
        	[bookmark: pgfId-3740922]The process ID number
  
       
 
        
        	[bookmark: pgfId-3740924]Username
  
        	[bookmark: pgfId-3740926]The name of the user or group running the process
  
       
 
        
        	[bookmark: pgfId-3740928]Pri
  
        	[bookmark: pgfId-3740930]The process priority
  
       
 
        
        	[bookmark: pgfId-3740932]Nice
  
        	[bookmark: pgfId-3740934]The nice value, which is a value that indicates the scheduling priority of a process. Values range between -20 (highest priority) and 19 (lowest priority)
  
       
 
        
        	[bookmark: pgfId-3740936]Size
  
        	[bookmark: pgfId-3740938]The memory size used by the process (in kilobytes unless the value is followed by m, which indicates megabytes)
  
       
 
        
        	[bookmark: pgfId-3740940]Res
  
        	[bookmark: pgfId-3740942]The amount of resident paging files in memory (in kilobytes unless the value is followed by m, which indicates megabytes)
  
       
 
        
        	[bookmark: pgfId-3740944]State
  
        	[bookmark: pgfId-3740946]The process state:
 
          
          	 [bookmark: pgfId-3740947]D — process is in uninterruptible sleep (usually Input/Output)
 
          	 [bookmark: pgfId-3740948]N — process has a positive nice value
 
          	 [bookmark: pgfId-3740949]R — process is runnable (on queue to run)
 
          	 [bookmark: pgfId-3740950]S — process is in sleep mode
 
          	 [bookmark: pgfId-3740951]T — process is being traced or stopped
 
          	 [bookmark: pgfId-3740952]W — process is paging
 
          	 [bookmark: pgfId-3740953]X — process is dead
 
          	 [bookmark: pgfId-3740954]Z — process is defunct
 
          	 [bookmark: pgfId-3740955]< — process has a negative nice value
 
         
  
       
 
        
        	[bookmark: pgfId-3740957]Time
  
        	[bookmark: pgfId-3740959]The amount of time (in hours:minutes:seconds) that the process has been running
  
       
 
        
        	[bookmark: pgfId-3740961]Cpu
  
        	[bookmark: pgfId-3740963]The percentage of CPU that the process is using
  
       
 
        
        	[bookmark: pgfId-3740965]Command
  
        	[bookmark: pgfId-3740967]The executable name of the process
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1885825]To expand the process list:
 
    [bookmark: pgfId-3777974]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-2319485]Step 1 Select System > Monitoring > Statistics.
 
    [bookmark: pgfId-2319486]The Statistics page appears.
 
    [bookmark: pgfId-3731439]Step 2 On the Defense Center, select the device or devices you want to view process statistics for from the Select Device(s) box and click Select Devices.
 
    [bookmark: pgfId-3672686]Step 3 Click the down arrow next to Processes.
 
    [bookmark: pgfId-2432789]The process list expands, listing general process status information that includes the number and types of running tasks, the current time, the current system uptime, the system load average, CPU, memory, and swap information, and specific information about each running process.
 
    [bookmark: pgfId-2432791]Cpu(s) lists the following CPU usage information:
 
     
      
      	 [bookmark: pgfId-1886317]user process usage percentage
 
      	 [bookmark: pgfId-1886318]system process usage percentage
 
      	 [bookmark: pgfId-1886319]nice usage percentage (CPU usage of processes that have a negative nice value, indicating a higher priority)
 
     
 
    
 
    [bookmark: pgfId-1886320]Nice values indicate the scheduled priority for system processes and can range between -20 (highest priority) and 19 (lowest priority).
 
     
      
      	 [bookmark: pgfId-1886321]idle usage percentage
 
     
 
    
 
    [bookmark: pgfId-1886322]Mem lists the following memory usage information: 
 
     
      
      	 [bookmark: pgfId-1886323]total number of kilobytes in memory
 
      	 [bookmark: pgfId-1886324]total number of used kilobytes in memory
 
      	 [bookmark: pgfId-1886325]total number of free kilobytes in memory
 
      	 [bookmark: pgfId-1886326]total number of buffered kilobytes in memory
 
     
 
    
 
    [bookmark: pgfId-1886327]Swap lists the following swap usage information:
 
     
      
      	 [bookmark: pgfId-1886328]total number of kilobytes in swap
 
      	 [bookmark: pgfId-1886329]total number of used kilobytes in swap
 
      	 [bookmark: pgfId-1886330]total number of free kilobytes in swap
 
      	 [bookmark: pgfId-1886331]total number of cached kilobytes in swap
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2193309]Note For more information about the types of processes that run on the appliance, see Understanding Running Processes.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3892398]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1887296]To collapse the process list:
 
    [bookmark: pgfId-3777979]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-1885848]Step 1 Click the up arrow next to Processes.
 
    [bookmark: pgfId-3643515]The process list collapses.
 
    [bookmark: pgfId-3892392]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3643554][bookmark: 22287][bookmark: 90556]Understanding Running Pr[bookmark: marker-3784440]ocesses
 
    [bookmark: pgfId-3866960]License: Any
 
    [bookmark: pgfId-1766117]There are two different types of processes that run on an appliance: daemons and executable files. Daemons always run, and executable files are run when required.
 
    [bookmark: pgfId-1869869]See the following sections for more information:
 
     
     	 [bookmark: pgfId-1766122]Understanding System Daemons
 
     	 [bookmark: pgfId-1766126]Understanding Executables and System Utilities
 
    
 
     
      [bookmark: pgfId-1766160][bookmark: 35744]Understanding[bookmark: marker-3717510] System Daemons
 
     [bookmark: pgfId-3866982]License: Any
 
     [bookmark: pgfId-1766161]Daemons continually run on an appliance. They ensure that services are available and spawn processes when required. The following table lists daemons that you may see on the Process Status page and provides a brief description of their functionality.
 
      
       
     
 
     
 
     [bookmark: pgfId-1766168]Note The table below is not an exhaustive list of all processes that may run on an appliance.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1766264]
 
      
       
        
        [bookmark: pgfId-3737802]Table 67-5 [bookmark: 94643]System Daemons 
 
        
        
         
         	 
           
           [bookmark: pgfId-3737806]Daemon 
          
  
         	 
           
           [bookmark: pgfId-3737808]Description 
          
  
        
 
         
         	[bookmark: pgfId-3737810]crond
  
         	[bookmark: pgfId-3737812]Manages the execution of scheduled commands (cron jobs)
  
        
 
         
         	[bookmark: pgfId-3737814]dhclient
  
         	[bookmark: pgfId-3737816]Manages dynamic host IP addressing
  
        
 
         
         	[bookmark: pgfId-3737818]fpcollect
  
         	[bookmark: pgfId-3737820]Manages the collection of client and server fingerprints
  
        
 
         
         	[bookmark: pgfId-3737822]httpd
  
         	[bookmark: pgfId-3737824]Manages the HTTP (Apache web server) process
  
        
 
         
         	[bookmark: pgfId-3737826]httpsd
  
         	[bookmark: pgfId-3737828]Manages the HTTPS (Apache web server with SSL) service, and checks for working SSL and valid certificate authentication; runs in the background to provide secure web access to the appliance
  
        
 
         
         	[bookmark: pgfId-3737833]keventd
  
         	[bookmark: pgfId-3737835]Manages Linux kernel event notification messages
  
        
 
         
         	[bookmark: pgfId-3737837]klogd
  
         	[bookmark: pgfId-3737839]Manages the interception and logging of Linux kernel messages
  
        
 
         
         	[bookmark: pgfId-3737841]kswapd
  
         	[bookmark: pgfId-3737843]Manages Linux kernel swap memory
  
        
 
         
         	[bookmark: pgfId-3737845]kupdated
  
         	[bookmark: pgfId-3737847]Manages the Linux kernel update process, which performs disk synchronization
  
        
 
         
         	[bookmark: pgfId-3737849]mysqld
  
         	[bookmark: pgfId-3737854]Manages FireSIGHT System database processes
  
        
 
         
         	[bookmark: pgfId-3737856]ntpd
  
         	[bookmark: pgfId-3737858]Manages the Network Time Protocol (NTP) process
  
        
 
         
         	[bookmark: pgfId-3737860]pm
  
         	[bookmark: pgfId-3737865]Manages all Cisco processes, starts required processes, restarts any process that fails unexpectedly
  
        
 
         
         	[bookmark: pgfId-3737867]reportd
  
         	[bookmark: pgfId-3737869]Manages reports
  
        
 
         
         	[bookmark: pgfId-3737878]safe_mysqld
  
         	[bookmark: pgfId-3737883]Manages safe mode operation of the database; restarts the database daemon if an error occurs and logs runtime information to a file
  
        
 
         
         	[bookmark: pgfId-3737885]SFDataCorrelator
  
         	[bookmark: pgfId-3737887]Manages data transmission
  
        
 
         
         	[bookmark: pgfId-3737889]sfestreamer
(Defense Center only)
  
         	[bookmark: pgfId-3737894]Manages connections to third-party client applications that use the Event Streamer
  
        
 
         
         	[bookmark: pgfId-3737896]sfmgr
  
         	[bookmark: pgfId-3737898]Provides the RPC service for remotely managing and configuring an appliance using an sftunnel connection to the appliance
  
        
 
         
         	[bookmark: pgfId-3737904]SFRemediateD
(Defense Center only — requires FireSIGHT)
  
         	[bookmark: pgfId-3737906]Manages remediation responses
  
        
 
         
         	[bookmark: pgfId-3737908]sftimeserviced
(Defense Center only)
  
         	[bookmark: pgfId-3737910]Forwards time synchronization messages to managed devices
  
        
 
         
         	[bookmark: pgfId-3737912]sfmbservice
(requires Protection)
  
         	[bookmark: pgfId-3737914]Provides access to the sfmb message broker process running on a remote appliance, using an sftunnel connection to the appliance. Currently used only by health monitoring to send health events and alerts from a managed device to a Defense Center or, in a high availability environment, between Defense Centers
  
        
 
         
         	[bookmark: pgfId-3737925]sftroughd
  
         	[bookmark: pgfId-3737927]Listens for connections on incoming sockets and then invokes the correct executable (typically the Cisco message broker, sfmb) to handle the request
  
        
 
         
         	[bookmark: pgfId-3737929]sftunnel
  
         	[bookmark: pgfId-3737931]Provides the secure communication channel for all processes requiring communication with a remote appliance
  
        
 
         
         	[bookmark: pgfId-3737933]sshd
  
         	[bookmark: pgfId-3737935]Manages the Secure Shell (SSH) process; runs in the background to provide SSH access to the appliance
  
        
 
         
         	[bookmark: pgfId-3737940]syslogd
  
         	[bookmark: pgfId-3737942]Manages the system logging (syslog) process
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-1766274][bookmark: 13617]Understanding Executables and[bookmark: marker-3717511] System Utilities
 
     [bookmark: pgfId-3866993]License: Any
 
     [bookmark: pgfId-1766275]There are a number of executables on the system that run when executed by other processes or through user action. The following table describes the executables that you may see on the Process Status page.
 
     [bookmark: pgfId-3852883]
 
      
       
        
        [bookmark: pgfId-3864169]Table 67-6 [bookmark: 81495]System Executables and Utilities 
 
        
        
         
         	 
           
           [bookmark: pgfId-3864173]Executable 
          
  
         	 
           
           [bookmark: pgfId-3864175]Description 
          
  
        
 
         
         	[bookmark: pgfId-3864177]awk
  
         	[bookmark: pgfId-3864179]Utility that executes programs written in the awk programming language
  
        
 
         
         	[bookmark: pgfId-3864181]bash
  
         	[bookmark: pgfId-3864183]GNU Bourne-Again SHell
  
        
 
         
         	[bookmark: pgfId-3864185]cat
  
         	[bookmark: pgfId-3864187]Utility that reads files and writes content to standard output
  
        
 
         
         	[bookmark: pgfId-3864189]chown
  
         	[bookmark: pgfId-3864191]Utility that changes user and group file permissions
  
        
 
         
         	[bookmark: pgfId-3864193]chsh
  
         	[bookmark: pgfId-3864195]Utility that changes the default login shell
  
        
 
         
         	[bookmark: pgfId-3864197]SFDataCorrelator
(Defense Center only — requires FireSIGHT)
  
         	[bookmark: pgfId-3864208]Analyzes binary files created by FireSIGHT to generate events, connection data, and the network map
  
        
 
         
         	[bookmark: pgfId-3864210]cp
  
         	[bookmark: pgfId-3864212]Utility that copies files
  
        
 
         
         	[bookmark: pgfId-3864214]df
  
         	[bookmark: pgfId-3864216]Utility that lists the amount of free space on the appliance
  
        
 
         
         	[bookmark: pgfId-3864218]echo
  
         	[bookmark: pgfId-3864220]Utility that writes content to standard output
  
        
 
         
         	[bookmark: pgfId-3864222]egrep
  
         	[bookmark: pgfId-3864224]Utility that searches files and folders for specified input; supports extended set of regular expressions not supported in standard grep
  
        
 
         
         	[bookmark: pgfId-3864226]find
  
         	[bookmark: pgfId-3864228]Utility that recursively searches directories for specified input
  
        
 
         
         	[bookmark: pgfId-3864230]grep
  
         	[bookmark: pgfId-3864232]Utility that searches files and directories for specified input
  
        
 
         
         	[bookmark: pgfId-3864234]halt
  
         	[bookmark: pgfId-3864236]Utility that stops the server
  
        
 
         
         	[bookmark: pgfId-3864238]httpsdctl
  
         	[bookmark: pgfId-3864240]Handles secure Apache Web processes
  
        
 
         
         	[bookmark: pgfId-3864242]hwclock
  
         	[bookmark: pgfId-3864244]Utility that allows access to the hardware clock
  
        
 
         
         	[bookmark: pgfId-3864246]ifconfig
  
         	[bookmark: pgfId-3864248]Indicates the network configuration executable. Ensures that the MAC address stays constant
  
        
 
         
         	[bookmark: pgfId-3864250]iptables
  
         	[bookmark: pgfId-3864252]Handles access restriction based on changes made to the Access Configuration page. See Configuring the Access List for Your Appliance for more information about access configuration.
  
        
 
         
         	[bookmark: pgfId-3864257]iptables-restore
  
         	[bookmark: pgfId-3864259]Handles iptables file restoration
  
        
 
         
         	[bookmark: pgfId-3864261]iptables-save
  
         	[bookmark: pgfId-3864263]Handles saved changes to the iptables
  
        
 
         
         	[bookmark: pgfId-3864265]kill
  
         	[bookmark: pgfId-3864267]Utility that can be used to end a session and process
  
        
 
         
         	[bookmark: pgfId-3864269]killall
  
         	[bookmark: pgfId-3864271]Utility that can be used to end all sessions and processes
  
        
 
         
         	[bookmark: pgfId-3864273]ksh
  
         	[bookmark: pgfId-3864275]Public domain version of the Korn shell
  
        
 
         
         	[bookmark: pgfId-3864277]logger
  
         	[bookmark: pgfId-3864279]Utility that provides a way to access the syslog daemon from the command line
  
        
 
         
         	[bookmark: pgfId-3864281]md5sum
  
         	[bookmark: pgfId-3864283]Utility that prints checksums and block counts for specified files
  
        
 
         
         	[bookmark: pgfId-3864285]mv
  
         	[bookmark: pgfId-3864287]Utility that moves (renames) files
  
        
 
         
         	[bookmark: pgfId-3864289]myisamchk
  
         	[bookmark: pgfId-3864291]Indicates database table checking and repairing
  
        
 
         
         	[bookmark: pgfId-3864293]mysql
  
         	[bookmark: pgfId-3864295]Indicates a database process; multiple instances may appear
  
        
 
         
         	[bookmark: pgfId-3864297]openssl
  
         	[bookmark: pgfId-3864299]Indicates authentication certificate creation
  
        
 
         
         	[bookmark: pgfId-3864301]perl
  
         	[bookmark: pgfId-3864303]Indicates a perl process
  
        
 
         
         	[bookmark: pgfId-3864305]ps
  
         	[bookmark: pgfId-3864307]Utility that writes process information to standard output
  
        
 
         
         	[bookmark: pgfId-3864323]sed
  
         	[bookmark: pgfId-3864325]Utility used to edit one or more text files
  
        
 
         
         	[bookmark: pgfId-3864327]sfheartbeat
  
         	[bookmark: pgfId-3864329]Identifies a heartbeat broadcast, indicating that the appliance is active; heartbeat used to maintain contact between a device and Defense Center
  
        
 
         
         	[bookmark: pgfId-3864334]sfmb
  
         	[bookmark: pgfId-3864336]Indicates a message broker process; handles communication between Defense Centers and device.
  
        
 
         
         	[bookmark: pgfId-3864341]sh
  
         	[bookmark: pgfId-3864343]Public domain version of the Korn shell
  
        
 
         
         	[bookmark: pgfId-3864345]shutdown
  
         	[bookmark: pgfId-3864347]Utility that shuts down the appliance
  
        
 
         
         	[bookmark: pgfId-3864349]sleep
  
         	[bookmark: pgfId-3864351]Utility that suspends a process for a specified number of seconds
  
        
 
         
         	[bookmark: pgfId-3864353]smtpclient
  
         	[bookmark: pgfId-3864355]Mail client that handles email transmission when email event notification functionality is enabled
  
        
 
         
         	[bookmark: pgfId-3864357]snmptrap
  
         	[bookmark: pgfId-3864359]Forwards SNMP trap data to the SNMP trap server specified when SNMP notification functionality is enabled
  
        
 
         
         	[bookmark: pgfId-3864361]snort
(requires Protection)
  
         	[bookmark: pgfId-3864366]Indicates that Snort is running
  
        
 
         
         	[bookmark: pgfId-3864368]ssh
  
         	[bookmark: pgfId-3864370]Indicates a Secure Shell (SSH) connection to the appliance
  
        
 
         
         	[bookmark: pgfId-3864372]sudo
  
         	[bookmark: pgfId-3864374]Indicates a sudo process, which allows users other than admin to run executables
  
        
 
         
         	[bookmark: pgfId-3864376]top
  
         	[bookmark: pgfId-3864378]Utility that displays information about the top CPU processes
  
        
 
         
         	[bookmark: pgfId-3864380]touch
  
         	[bookmark: pgfId-3864382]Utility that can be used to change the access and modification times of specified files
  
        
 
         
         	[bookmark: pgfId-3864384]vim
  
         	[bookmark: pgfId-3864386]Utility used to edit text files
  
        
 
         
         	[bookmark: pgfId-3864388]wc
  
         	[bookmark: pgfId-3864390]Utility that performs line, word, and byte counts on specified files
  
        
 
        
      
 
     
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-5699268][bookmark: 14680]Using[bookmark: marker-5699267] Health Monitoring 
      
      
 
     
 
 
    [bookmark: pgfId-5699271]The health monitor provides numerous tests for determining the health of an appliance from the Defense Center. You can use the health monitor to create a collection of tests, referred to as a health policy, and apply the health policy to one or more appliances. You can create one health policy for every appliance in your system, customize a health policy for the specific appliance where you plan to apply it, or use the default health policy. You can also import a health policy exported from another Defense Center.
 
    [bookmark: pgfId-3610011]The tests, referred to as health modules, are scripts that test for criteria you specify. You can modify a health policy by enabling or disabling tests or by changing test settings, and you can delete health policies that you no longer need. You can also suppress messages from selected appliances by blacklisting them.
 
    [bookmark: pgfId-3610148]The tests in a health policy run automatically at the interval you configure. You can also run all tests, or a specific test, on demand. The health monitor collects health events based on the test conditions configured. Optionally, you can also configure email, SNMP, or syslog alerting in response to health events.
 
    [bookmark: pgfId-3610869]On the Defense Center, you can view health status information for the entire system or for a particular appliance. Fully customizable event views allow you to quickly and easily analyze the health status events gathered by the health monitor. These event views allow you to search and view event data and to access other information that may be related to the events you are investigating. 
 
    [bookmark: pgfId-3608803]You can also generate troubleshooting files for an appliance if you are asked to do so by Support.
 
    [bookmark: pgfId-3518680]See the following sections for more information:
 
     
     	 [bookmark: pgfId-3518693]Understanding Health Monitoring
 
     	 [bookmark: pgfId-3518732]Configuring Health Policies
 
     	 [bookmark: pgfId-3892951]Using the Health Monitor Blacklist
 
     	 [bookmark: pgfId-3518758]Configuring Health Monitor Alerts
 
     	 [bookmark: pgfId-5178260]Using the Health Monitor
 
     	 [bookmark: pgfId-5178264]Using Appliance Health Monitors
 
     	 [bookmark: pgfId-5178268]Working with Health Events
 
    
 
   
 
    
     [bookmark: pgfId-3349667][bookmark: 32778]Understanding Health Mo[bookmark: marker-3349666]nitoring
 
    [bookmark: pgfId-5349645]License: Any
 
    [bookmark: pgfId-3349670]You can use the health monitor to check the status of critical functionality across your FireSIGHT System deployment. Monitor the health of your entire FireSIGHT System through the Defense Center by applying health policies to each of the managed devices and collecting the resulting health data at the Defense Center. Pie charts and status tables on the Health Monitor page visually represent the health status for monitored appliances, so you can check status at a glance, then drill down into status details if needed.
 
    [bookmark: pgfId-5731492]
 
     
     [image: ] 
    
 
    [bookmark: pgfId-5307268]You can use the health monitor to access health status information for the entire system or for a particular appliance. The Health Monitor page provides a visual summary of the status of all appliances on your system. Individual appliance health monitors let you drill down into health details for a specific appliance. 
 
    [bookmark: pgfId-3349693]You can also view health events in the standard FireSIGHT System table view. From an individual appliance’s health monitor, you can open a table view of occurrences of a specific event, or you can retrieve all the health events for that appliance. You can also search for specific health events. For example, if you want to see all the occurrences of CPU usage with a certain percentage, you can search for the CPU usage module and enter the percentage value.
 
    [bookmark: pgfId-3349694]You can also configure email, SNMP, or syslog alerting in response to health events. A health alert is an association between a standard alert and a health status level. For example, if you need to make sure an appliance never fails due to hardware overload, you can set up an email alert. You can then create a health alert that triggers that email alert whenever CPU, disk, or memory usage reaches the Warning level you configure in the health policy applied to that appliance. You can set alerting thresholds to minimize the number of repeating alerts you receive. 
 
    [bookmark: pgfId-3349695]Because health monitoring is an administrative activity, only users with administrator user role privileges can access system health data. For more information on assigning user privileges, see Modifying User Privileges and Options.
 
     
      
    
 
    
 
    [bookmark: pgfId-3349705]Note Except for the Defense Center, FireSIGHT System devices do not have health monitoring policies applied to them by default. Managed devices report hardware status automatically via the Hardware Alarms health module; if you want to use other modules to monitor a managed device, you must apply a health policy to that device. For more information on the Cisco-provided default health policy for your appliances, see Understanding the Default Health Policy. For more information on creating customized health policies, see Creating Health Policies. For details on applying policies, see Applying Health Policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3349715]For more information on health policies and the health modules you can run to test system health, see the following topics:
 
     
     	 [bookmark: pgfId-3349719]Understanding Health Policies
 
     	 [bookmark: pgfId-3349723]Understanding Health Modules
 
     	 [bookmark: pgfId-3349727]Understanding Health Monitoring Configuration
 
    
 
     
      [bookmark: pgfId-3349790][bookmark: 57379]Understanding[bookmark: marker-3750331] Health Policies
 
     [bookmark: pgfId-5349663]License: Any
 
     [bookmark: pgfId-5696335]A health policy is a collection of health module settings you apply to an appliance to define the criteria that the Defense Center uses when checking the health of the appliance. The health monitor tracks a variety of health indicators to ensure that your FireSIGHT System hardware and software are working correctly. 
 
     [bookmark: pgfId-3349798]When you create health policies, you choose which tests to run to determine appliance health. You can also apply the default health policy to any appliance.
 
    
 
     
      [bookmark: pgfId-5158472][bookmark: 79312]Understanding Health Mod[bookmark: marker-5158471]ules
 
     [bookmark: pgfId-5349686]License: Any
 
     [bookmark: pgfId-5158868]Health modules, also sometimes referred to as health tests, are scripts that test for the criteria you specify in a health policy. The available health modules are described in the following table. 
 
      
       [bookmark: pgfId-5159042]
 
       
        
         
         [bookmark: pgfId-5704658]Table 68-1 [bookmark: 36863]Health Modules 
 
         
         
          
          	 
            
            [bookmark: pgfId-5704662]Module 
           
  
          	 
            
            [bookmark: pgfId-5704664]Description 
           
  
         
 
          
          	[bookmark: pgfId-5704667]Advan[bookmark: marker-5704666]ced Malware Protection
  
          	[bookmark: pgfId-5704674]This module alerts if the Defense Center cannot contact the Collective Security Intelligence Cloud, either to retrieve file disposition information for files detected in network traffic or to submit files for dynamic analysis, or if an excessive number of files are detected in network traffic, based on the file policy configuration. Connections via the FireAMP Private Cloud also generate alerts if the private cloud cannot connect to the public Cisco cloud.
 [bookmark: pgfId-5704685]This module runs on all Defense Centers except the DC500, which does not support advanced malware protection.
  
         
 
          
          	[bookmark: pgfId-5704688]Appliance Heart[bookmark: marker-5704687]beat
  
          	[bookmark: pgfId-5704690]This module determines if an appliance heartbeat is being heard from the appliance and alerts based on the appliance heartbeat status.
  
         
 
          
          	[bookmark: pgfId-5704693]Automatic Appli[bookmark: marker-5704692]cation Bypass Status
  
          	[bookmark: pgfId-5704695]This module determines if an appliance has been bypassed because it did not respond within the number of seconds set in the bypass threshold, and alerts when a bypass occurs. 
  
         
 
          
          	[bookmark: pgfId-5704698]CPU Us[bookmark: marker-5704697]age
  
          	[bookmark: pgfId-5704700]This module checks that the CPU on the appliance is not overloaded and alerts when CPU usage exceeds the percentages configured for the module.
 [bookmark: pgfId-5704701]This module is not available for health policies applied to 3D9900 devices.
  
         
 
          
          	[bookmark: pgfId-5704704]Card [bookmark: marker-5704703]Reset
  
          	[bookmark: pgfId-5704706]This module checks for network cards which have restarted due to hardware failure and alerts when a reset occurs. 
  
         
 
          
          	[bookmark: pgfId-5704709]Disk S[bookmark: marker-5704708]tatus
  
          	[bookmark: pgfId-5704711]This module examines performance of the hard disk, and malware storage pack (if installed) on the appliance. It alerts when the hard disks and RAID controller (if installed) are in danger of failing, or if the malware storage pack is not detected after installation or inauthentic.
  
         
 
          
          	[bookmark: pgfId-5704714]Di[bookmark: marker-5704713]sk Usage 
  
          	[bookmark: pgfId-5704716]This module compares disk usage on the appliance’s hard drive and malware storage pack to the limits configured for the module and alerts when usage exceeds the percentages configured for the module. This module also alerts when the system excessively deletes files in monitored disk usage categories, or when disk usage excluding those categories reaches excessive levels, based on module thresholds.
  
         
 
          
          	[bookmark: pgfId-5704737]FireAMP Status Mo[bookmark: marker-5704736]nitor
  
          	[bookmark: pgfId-5704745]The module alerts if the Defense Center cannot connect to the Cisco cloud after an initial successful connection, if you deregister a cloud connection using the FireAMP portal, or if your private cloud is unable to communicate with the public Cisco cloud.
 [bookmark: pgfId-5704752]This module only runs on Defense Centers.
  
         
 
          
          	[bookmark: pgfId-5704758]FireSIGHT Host Licens[bookmark: marker-5704757]e Limit
  
          	[bookmark: pgfId-5704763]This module determines if sufficient FireSIGHT host licenses remain and alerts based on the warning level configured for the module. 
 [bookmark: pgfId-5704767]This module only runs on Defense Centers.
  
         
 
          
          	[bookmark: pgfId-5704770]Hardware A[bookmark: marker-5704769]larms
  
          	[bookmark: pgfId-5704775]This module determines if hardware needs to be replaced on a Series 3 or 3D9900 device and alerts based on the hardware status. The module also reports on the status of hardware-related daemons and on the status of clustered appliances.
 [bookmark: pgfId-5704778]For more information on the details reported for these devices, see Interpreting Hardware Alert Details for 3D9900 Devices and Interpreting Hardware Alert Details for Series 3 Devices.
  
         
 
          
          	[bookmark: pgfId-5704785]Health M[bookmark: marker-5704784]onitor Process
  
          	[bookmark: pgfId-5704787]This module monitors the status of the health monitor itself and alerts if the number of minutes since the last health event received by the Defense Center exceeds the Warning or Critical limits. 
 [bookmark: pgfId-5704794]This module only runs on Defense Centers.
  
         
 
          
          	[bookmark: pgfId-5704796]Inline Link Mismatch Alarms
  
          	[bookmark: pgfId-5704798]This module monitors the ports associated with inline sets and alerts if the two interfaces of an inline pair negotiate different speeds.
  
         
 
          
          	[bookmark: pgfId-5704801]Intrusion Eve[bookmark: marker-5704800]nt Rate
  
          	[bookmark: pgfId-5704803]This module compares the number of intrusion events per second to the limits configured for this module and alerts if the limits are exceeded. If the Intrusion Event Rate is zero, the intrusion process may be down or the managed device may not be sending events. Select  Analysis > Intrusions > Events to check if events are being received from the device.
  
         
 
          
          	[bookmark: pgfId-5704807]Inte[bookmark: marker-5704805]rface Stat[bookmark: marker-5704806]us
  
          	[bookmark: pgfId-5704809]This module determines if the device currently collects traffic and alerts based on the traffic status of physical interfaces and aggregate interfaces. For physical interfaces, the information includes interface name, link state, and bandwidth. For aggregate interfaces, the information includes interface name, number of active links, and total aggregate bandwidth.
  
         
 
          
          	[bookmark: pgfId-5704812]Licen[bookmark: marker-5704811]se Monitor
  
          	[bookmark: pgfId-5704826]This module determines if sufficient licenses for Control, Protection, URL Filtering, Malware, and VPN remain. It also alerts when devices in a stack have mismatched license sets. It alerts based on a warning level automatically configured for the module. You cannot change the configuration of this module.
 [bookmark: pgfId-5704833]This module only runs on Defense Centers.
  
         
 
          
          	[bookmark: pgfId-5704836][bookmark: marker-5704835]Link State Propagation
  
          	[bookmark: pgfId-5704838]This module determines when a link in a paired inline set fails and triggers the link state propagation mode. 
  
         
 
          
          	[bookmark: pgfId-5704841]Me[bookmark: marker-5704840]mory Usage
  
          	[bookmark: pgfId-5704843]This module compares memory usage on the appliance to the limits configured for the module and alerts when usage exceeds the levels configured for the module.
  
         
 
          
          	[bookmark: pgfId-5704846]Power Su[bookmark: marker-5704845]pply
  
          	[bookmark: pgfId-5704848]This module determines if power supplies on the device require replacement and alerts based on the power supply status.
 [bookmark: pgfId-5704854]This module runs on these Defense Centers: DC1500, DC2000, DC3500, DC4000.
 [bookmark: pgfId-5704858]This module runs on these devices: 3D3500, 3D4500, 3D6500, 3D9900, and Series 3.
  
         
 
          
          	[bookmark: pgfId-5704861]Proce[bookmark: marker-5704860]ss Status
  
          	[bookmark: pgfId-5704863]This module determines if processes on the appliance exit or terminate outside of the process manager. If a process is deliberately exited outside of the process manager, the module status changes to Warning and the health event message indicates which process exited, until the module runs again and the process has restarted. If a process terminates abnormally or crashes outside of the process manager, the module status changes to Critical and the health event message indicates the terminated process, until the module runs again and the process has restarted.
  
         
 
          
          	[bookmark: pgfId-5704947]Reconfiguring Detection
  
          	[bookmark: pgfId-5704949]This module determines if detection capabilities persist after a failed policy apply on a registered managed device. If detection capabilities appear un-operational after a policy apply fails, the module generates health alerts until detection capabilities are reestablished.
  
         
 
          
          	[bookmark: pgfId-5704866]RRD Serv[bookmark: marker-5704865]er Process
  
          	[bookmark: pgfId-5704868]This module determines if the round robin data server that stores time series data is running properly and alerts based on the number of recent RRD server restarts.
 [bookmark: pgfId-5704872]This module only runs on Defense Centers.
  
         
 
          
          	[bookmark: pgfId-5704875]Security Intel[bookmark: marker-5704874]ligence
  
          	[bookmark: pgfId-5704877]This module alerts in a variety of situations involving Security Intelligence filtering, including feed update, feed corruption, and memory issues.
 [bookmark: pgfId-5704881]This module runs on all Defense Centers except the DC500, which does not support Security Intelligence filtering.
  
         
 
          
          	[bookmark: pgfId-5704884]Time S[bookmark: marker-5704883]eries Data Monitor
  
          	[bookmark: pgfId-5704886]This module tracks the presence of corrupt files in the directory where time series data (such as compliance event counts) are stored and alerts when files are flagged as corrupt and removed.
 [bookmark: pgfId-5704890]This module only runs on Defense Centers.
  
         
 
          
          	[bookmark: pgfId-5704893]Time Synchronizat[bookmark: marker-5704892]ion Status
  
          	[bookmark: pgfId-5704895]This module tracks the synchronization of a device clock that obtains time using NTP with the clock on the NTP server and alerts if the difference in the clocks is more than ten seconds. 
  
         
 
          
          	[bookmark: pgfId-5704898]URL Filtering Mo[bookmark: marker-5704897]nitor
  
          	[bookmark: pgfId-5704906]This module tracks communication between the Defense Center and the Cisco cloud, where the system obtains its URL filtering (category and reputation) data for commonly visited URLs. The module alerts if the Defense Center fails to successfully communicate with or retrieve an update from the cloud.
 [bookmark: pgfId-5704913]This module also tracks communications between the Defense Center and any managed devices where you have enabled URL filtering. The module alerts if the Defense Center cannot push URL filtering data to those devices.
 [bookmark: pgfId-5704920]This module only runs on all Defense Centers except the DC500, which does not support URL filtering.
  
         
 
          
          	[bookmark: pgfId-5704923]User Agent S[bookmark: marker-5704922]tatus Monitor
  
          	[bookmark: pgfId-5704925]This module alerts when heartbeats are not detected for any User Agents connected to the Defense Center. 
 [bookmark: pgfId-5704932]This module only runs on Defense Centers.
  
         
 
          
          	[bookmark: pgfId-5704935]VPN St[bookmark: marker-5704934]atus
  
          	[bookmark: pgfId-5704937]This module alerts when the system detects that the VPN feature is not functioning. 
 [bookmark: pgfId-5704941]This module only runs on Defense Centers.
  
         
 
         
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-5158751][bookmark: 22265]Understanding Health Monitor[bookmark: marker-5158750]ing Configuration
 
     [bookmark: pgfId-5349713]License: Any
 
     [bookmark: pgfId-5158754]There are several steps to setting up health monitoring on your FireSIGHT System, as indicated in the following procedure:
 
     
 
     [bookmark: pgfId-3349969]Step 1 Create health policies for your appliances. 
 
     [bookmark: pgfId-3349972]You can set up specific policies for each kind of appliance you have in your FireSIGHT System, enabling only the appropriate tests for that appliance. 
 
      
       
     
 
     
 
     [bookmark: pgfId-3349974]Tip If you want to quickly enable health monitoring without customizing the monitoring behavior, you can apply the default policy provided for that purpose. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3349977]For more information on setting up health policies, see Configuring Health Policies. 
 
     [bookmark: pgfId-3349979]Step 2 Apply a health policy to each appliance where you want to track health status. For information on the default health policy available for immediate application, see Understanding the Default Health Policy.
 
     [bookmark: pgfId-3349983]Step 3 Optionally, configure health monitor alerts.
 
     [bookmark: pgfId-3349984]You can set up email, syslog, or SNMP alerts that trigger when the health status level reaches a particular severity level for specific health modules. 
 
     [bookmark: pgfId-3349987]For more information on setting up health monitor alerts, see Configuring Health Monitor Alerts.
 
     [bookmark: pgfId-5611063]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3349989]After you set up health monitoring on your system, you can view the health status at any time on the Health Monitor page or the Health Events table view. For more information about viewing system health data, see the following topics: 
 
      
      	 [bookmark: pgfId-3349993]Using the Health Monitor 
 
      	 [bookmark: pgfId-3349997]Using Appliance Health Monitors 
 
      	 [bookmark: pgfId-3350001]Working with Health Events 
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3350021][bookmark: 11455]Configuring Health Poli[bookmark: marker-3350020]cies
 
    [bookmark: pgfId-5349720]License: Any
 
    [bookmark: pgfId-3350023]A health policy contains configured health test criteria for several modules. You can control which health modules run against each of your appliances and configure the specific limits used in the tests run by each module. For more information on the health modules you can configure in a health policy, see Understanding Health Monitoring.
 
    [bookmark: pgfId-4972756]You can create one health policy that can be applied to every appliance in your system, customize each health policy to the specific appliance where you plan to apply it, or use the default health policy provided for you. You can also import a health policy exported from another Defense Center.
 
    [bookmark: pgfId-5235325]When you configure a health policy, you decide whether to enable each health module for that policy. You also select the criteria that control which health status each enabled module reports each time it assesses the health of a process. 
 
    [bookmark: pgfId-5235328]For more information on the default health policy, which is applied to the Defense Center automatically, see Understanding the Default Health Policy.
 
    [bookmark: pgfId-5235336]For more information, see the following topics:
 
     
     	 [bookmark: pgfId-5235340]Understanding the Default Health Policy
 
     	 [bookmark: pgfId-3350043]Creating Health Policies
 
     	 [bookmark: pgfId-3350047]Applying Health Policies
 
     	 [bookmark: pgfId-3350051]Editing Health Policies
 
     	 [bookmark: pgfId-5208849]Comparing Health Policies
 
     	 [bookmark: pgfId-3350055]Deleting Health Policies
 
    
 
     
      [bookmark: pgfId-3350118]Understanding the Default [bookmark: 34723]Health Poli[bookmark: marker-3350117]cy
 
     [bookmark: pgfId-5349738]License: Any
 
     [bookmark: pgfId-3350122]The Defense Center health monitor includes a default health policy to make it easier for you to quickly implement health monitoring for your appliances. The default health policy is automatically applied to the Defense Center. You cannot edit the default health policy, but you can copy it to create custom policies based on its configuration. For more information, see Creating Health Policies.
 
     [bookmark: pgfId-5226838]To also monitor device health, you can push health policies to your managed devices. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5542624]Note You cannot apply a health policy to [bookmark: marker-5547493]Cisco NGIPS for Blue Coat X-Series.
 
      
      
 
     
 
     
 
      
      [bookmark: pgfId-5305755]Module 
     
 
      
      [bookmark: pgfId-5305760]Defense Center 
     
 
      
      [bookmark: pgfId-5305762]Managed Device 
     
 
     [bookmark: pgfId-5435597]Advanced Malware Protection
 
     [bookmark: pgfId-5435599]yes
 
     [bookmark: pgfId-5435601]no
 
     [bookmark: pgfId-5305764]Appliance Heartbeat
 
     [bookmark: pgfId-5305766]yes
 
     [bookmark: pgfId-5305768]no
 
     [bookmark: pgfId-5305770]Automatic Application Bypass
 
     [bookmark: pgfId-5546917]no
 
     [bookmark: pgfId-5305774]yes
 
     [bookmark: pgfId-5305776]CPU Usage
 
     [bookmark: pgfId-5546919]no
 
     [bookmark: pgfId-5546913]no
 
     [bookmark: pgfId-5305782]Card Reset
 
     [bookmark: pgfId-5546921]no
 
     [bookmark: pgfId-5546915]no
 
     [bookmark: pgfId-5477157]Disk Status
 
     [bookmark: pgfId-5546815]yes
 
     [bookmark: pgfId-5546811]yes
 
     [bookmark: pgfId-5305794]Disk Usage
 
     [bookmark: pgfId-5546817]yes
 
     [bookmark: pgfId-5546813]yes
 
     [bookmark: pgfId-5378462]FireAMP Status Monitor
 
     [bookmark: pgfId-5546819]yes
 
     [bookmark: pgfId-5546925]no
 
     [bookmark: pgfId-5305809]FireSIGHT Host License Limit
 
     [bookmark: pgfId-5546821]yes
 
     [bookmark: pgfId-5546927]no
 
     [bookmark: pgfId-5305815]Hardware Alarm
 
     [bookmark: pgfId-5305817]no
 
     [bookmark: pgfId-5305819]yes
 
     [bookmark: pgfId-5305821]Health Monitor Process
 
     [bookmark: pgfId-5546929]no
 
     [bookmark: pgfId-5305825]no
 
     [bookmark: pgfId-5531465]Inline Link Mismatch Alarms
 
     [bookmark: pgfId-5546931]no
 
     [bookmark: pgfId-5546823]yes
 
     [bookmark: pgfId-5697950]Interface Status
 
     [bookmark: pgfId-5697952]no
 
     [bookmark: pgfId-5697954]yes
 
     [bookmark: pgfId-5305827]Intrusion Event Rate
 
     [bookmark: pgfId-5305829]no
 
     [bookmark: pgfId-5546825]yes
 
     [bookmark: pgfId-5319039]License Monitor
 
     [bookmark: pgfId-5319041]yes
 
     [bookmark: pgfId-5319043]no
 
     [bookmark: pgfId-5305839]Link State Propagation
 
     [bookmark: pgfId-5305841]no
 
     [bookmark: pgfId-5546827]yes
 
     [bookmark: pgfId-5305845]Memory Usage
 
     [bookmark: pgfId-5305847]yes
 
     [bookmark: pgfId-5546829]yes
 
     [bookmark: pgfId-5305860]Power Supply
 
     [bookmark: pgfId-5305862]no
 
     [bookmark: pgfId-5546831]yes
 
     [bookmark: pgfId-5305866]Process Status
 
     [bookmark: pgfId-5305868]yes
 
     [bookmark: pgfId-5546833]yes
 
     [bookmark: pgfId-5705222]Reconfiguring Detection
 
     [bookmark: pgfId-5705224]no
 
     [bookmark: pgfId-5705226]yes
 
     [bookmark: pgfId-5316225]RRD Server Process
 
     [bookmark: pgfId-5546847]yes
 
     [bookmark: pgfId-5546933]no
 
     [bookmark: pgfId-5412426]Security Intelligence
 
     [bookmark: pgfId-5546849]yes
 
     [bookmark: pgfId-5546935]no
 
     [bookmark: pgfId-5316219]Time Series Data Monitor
 
     [bookmark: pgfId-5546843]yes
 
     [bookmark: pgfId-5316223]no
 
     [bookmark: pgfId-5305872]Time Synchronization Status
 
     [bookmark: pgfId-5546845]yes
 
     [bookmark: pgfId-5546835]yes
 
     [bookmark: pgfId-5305884]URL Filtering Monitor
 
     [bookmark: pgfId-5305886]yes
 
     [bookmark: pgfId-5305888]no
 
     [bookmark: pgfId-5378501]User Agent Status Monitor
 
     [bookmark: pgfId-5546839]yes
 
     [bookmark: pgfId-5546937]no
 
     [bookmark: pgfId-5470672]VPN Status
 
     [bookmark: pgfId-5546841]yes
 
     [bookmark: pgfId-5546939]no
 
    
 
   
 
    
     [bookmark: pgfId-5263031][bookmark: 60847]Creating He[bookmark: marker-5263029]alth Policies
 
    [bookmark: pgfId-5105955]License: Any
 
    [bookmark: pgfId-3350749]If you want to customize a health policy to use with your appliances, you can create a new policy. The settings in the policy initially populate with the settings from the health policy you select as a basis for the new policy. You can enable or disable modules within the policy and change the alerting criteria for each module as needed.
 
     
      
    
 
    
 
    [bookmark: pgfId-4972783]Tip Instead of creating a new policy, you can export a health policy from another Defense Center and then import it onto your Defense Center. You can then edit the imported policy to suit your needs before you apply it. For more information, see Importing and Exporting Configurations.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3350750]To create a health policy:
 
    [bookmark: pgfId-4157586]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3350751]Step 1 Select Health > Health Policy.
 
    [bookmark: pgfId-3350752]The Health Policy page appears.
 
    [bookmark: pgfId-3446004]Step 2 Click Create Policy.
 
    [bookmark: pgfId-3446005]The Create Health Policy page appears. 
 
    [bookmark: pgfId-3350769]Step 3 Select the existing policy that you want to use as the basis for the new policy from the Copy Policy drop-down list.
 
    [bookmark: pgfId-3350770]Step 4 Enter a name for the policy.
 
    [bookmark: pgfId-3350771]Step 5 Enter a description for the policy.
 
    [bookmark: pgfId-3350772]Step 6 Select Save to save the policy information.
 
    [bookmark: pgfId-5378725]The Health Policy Configuration page appears, including a list of the modules.
 
    [bookmark: pgfId-5379554]Step 7 Configure settings on each module you want to use to test the health status of your appliances, as described in the following sections:
 
     
      
      	 [bookmark: pgfId-5379558]Configuring Policy Run Time Intervals
 
      	 [bookmark: pgfId-5435730]Configuring Advanced Malware Protection Monitoring
 
      	 [bookmark: pgfId-5379562]Configuring Appliance Heartbeat Monitoring
 
      	 [bookmark: pgfId-4861784]Configuring Automatic Application Bypass Monitoring
 
      	 [bookmark: pgfId-3350794]Configuring CPU Usage Monitoring
 
      	 [bookmark: pgfId-4871830]Configuring Card Reset Monitoring
 
      	 [bookmark: pgfId-5477136]Configuring Disk Status Monitoring
 
      	 [bookmark: pgfId-3892979]Configuring Disk Usage Monitoring
 
      	 [bookmark: pgfId-5378793]Configuring FireAMP Status Monitoring
 
      	 [bookmark: pgfId-5237290]Configuring FireSIGHT Host Usage Monitoring
 
      	 [bookmark: pgfId-4776666]Configuring Hardware Alarm Monitoring
 
      	 [bookmark: pgfId-5378805]Configuring Health Status Monitoring
 
      	 [bookmark: pgfId-5533310]Configuring Inline Link Mismatch Alarm Monitoring
 
      	 [bookmark: pgfId-5699121]Configuring Interface Status Monitoring
 
      	 [bookmark: pgfId-5378912]Configuring Intrusion Event Rate Monitoring
 
      	 [bookmark: pgfId-5285226]Understanding License Monitoring
 
      	 [bookmark: pgfId-4776674]Configuring Link State Propagation Monitoring
 
      	 [bookmark: pgfId-4300676]Configuring Memory Usage Monitoring
 
      	 [bookmark: pgfId-4776682]Configuring Power Supply Monitoring
 
      	 [bookmark: pgfId-5159814]Configuring Process Status Monitoring
 
      	 [bookmark: pgfId-5705272]Configuring Reconfiguring Detection Monitoring
 
      	 [bookmark: pgfId-5318656]Configuring RRD Server Process Monitoring
 
      	 [bookmark: pgfId-5413630]Configuring Security Intelligence Monitoring
 
      	 [bookmark: pgfId-5318663]Configuring Time Series Data Monitoring
 
      	 [bookmark: pgfId-4796874]Configuring Time Synchronization Monitoring
 
      	 [bookmark: pgfId-5237392]Configuring URL Filtering Monitoring
 
      	 [bookmark: pgfId-5379050]Configuring User Agent Status Monitoring
 
      	 [bookmark: pgfId-5470657]Configuring VPN Status Monitoring
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-3350843]Note Make sure you enable each module that you want to run to test the health status on each Health Policy Configuration page as you configure the settings. Disabled modules do not produce health status feedback, even if the policy that contains the module has been applied to an appliance.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3350844]Step 8 Click Save Policy and Exit to save the policy.
 
    [bookmark: pgfId-3350845]You must apply the policy to each appliance for it to take effect. For more information on applying health policies, see Applying Health Policies.
 
    [bookmark: pgfId-5611256]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3350870][bookmark: 51152]Configuring Policy Run Time Intervals
 
    [bookmark: pgfId-5105983]License: Any
 
    [bookmark: pgfId-3350871]You can control how often health tests run by modifying the Policy Run Time Interval for the health policy. The maximum run time interval you can set is 99999 minutes.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-3485387] 
     Caution Do not set a run interval of less than five minutes. 
      
      
 
     
 
    
 
    [bookmark: pgfId-3350872]To configure a policy run time interval:
 
    [bookmark: pgfId-5235579]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5235580]Step 1 On the Health Policy Configuration page, select Policy Run Time Interval.
 
    [bookmark: pgfId-5235581]The Health Policy Configuration — Policy Run Time Interval page appears.
 
    [bookmark: pgfId-5235576]Step 2 In the Run Interval (mins) field, enter the time in minutes that you want to elapse between automatic repetitions of the test.
 
    [bookmark: pgfId-5235533]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5235534]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-3350883]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-3350884]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-3350885]You must apply the health policy to the appropriate appliances if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611392]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5435640][bookmark: 40096]Configuring Advanced Malware Pro[bookmark: marker-5464005]tection Monitoring
 
    [bookmark: pgfId-5435717]License: Malware
 
    [bookmark: pgfId-5699822]This module tracks the state and stability of the Defense Center’s ability to query the Cisco cloud and detect files in network traffic. If the system detects that your connection with the cloud is interrupted, the encryption keys used for the connection are invalid, or the number of files detected in a time frame is excessive, the status classification for this module changes to Warning and the module generates a health alert. Note that if you are using a FireAMP Private Cloud and it is unable to communicate with the public Cisco cloud, the private cloud itself generates an alert; for more information, see the FireAMP Private Cloud Administration Portal User Guide.
 
     
      
    
 
    
 
    [bookmark: pgfId-5692535]Note If your Defense Center loses connectivity to the Internet, the system may take up to 30 minutes to generate an Advanced Malware Protection health alert.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5440232]To configure Advanced Malware Protection health module settings:
 
    [bookmark: pgfId-5440341]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5440368]Step 1 In the Health Policy Configuration page, select Advanced Malware Protection.
 
    [bookmark: pgfId-5440451]The Health Policy Configuration — Advanced Malware Protection page appears.
 
    [bookmark: pgfId-5440534]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5440620]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5440621]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5440622]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5440623]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5440624]You must apply the health policy to the appropriate appliances if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611408]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3889124][bookmark: 74331]Configuring Appliance Heartbeat Mo[bookmark: marker-4068796]nitoring
 
    [bookmark: pgfId-5235500]License: Any
 
    [bookmark: pgfId-5235508]The Defense Center receives heartbeats from its managed devices once every two minutes or every 200 events, whichever comes first, as an indicator that the device is running and communicating properly with the Defense Center. Use the Appliance Heartbeat health status module to track whether the Defense Center receives heartbeats from managed appliances. If the Defense Center does not detect a heartbeat from a device, the status classification for this module changes to Critical. That status data feeds into the health monitor.
 
    [bookmark: pgfId-3889142]To configure Appliance Heartbeat health module settings:
 
    [bookmark: pgfId-4242131]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3889143]Step 1 In the Health Policy Configuration page, select Appliance Heartbeat. 
 
    [bookmark: pgfId-3889144]The Health Policy Configuration — Appliance Heartbeat page appears.
 
    [bookmark: pgfId-3889149]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-3889150]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-3889151]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-3889152]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-3889153]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-3889154]You must apply the health policy to the appropriate appliances if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611432]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4776689][bookmark: 61512]Configuring Automatic[bookmark: marker-5005949] Application Bypass Monitoring
 
    [bookmark: pgfId-5107070]License: Any
 
    [bookmark: pgfId-4856425]Use this module to detect when a managed device is bypassed because it did not respond within the number of seconds configured as the bypass threshold. If a bypass occurs, this module generates an alert. That status data feeds into the health monitor.
 
    [bookmark: pgfId-4862793]For more information on automatic application bypass, see Automatic Application Bypass.
 
    [bookmark: pgfId-4855757]To configure automatic application bypass monitoring status:
 
    [bookmark: pgfId-4855758]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-4855762]Step 1 In the Health Policy Configuration page, select Automatic Application Bypass Status. 
 
    [bookmark: pgfId-5530848]The Health Policy Configuration — Automatic Application Bypass Status page appears.
 
    [bookmark: pgfId-4855771]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-4855772]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-4855773]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-4855774]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-4855775]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-4855779]You must apply the health policy to the appropriate managed device if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611447]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3351048][bookmark: 71081]Configuring [bookmark: marker-3750343]CPU Usage Monitoring
 
    [bookmark: pgfId-5591158]License: Any
 
    [bookmark: pgfId-5591162]Supported Devices: Any except 3D9900
 
    [bookmark: pgfId-5591166]Supported Defense Centers: Any
 
    [bookmark: pgfId-3351678]Excessive CPU usage may indicate that you need to upgrade your hardware or that there are processes that are not functioning correctly. Use the CPU Usage health status module to set CPU usage limits. 
 
    [bookmark: pgfId-3351679]If the CPU usage on the monitored appliance exceeds the Warning limit, the status classification for that module changes to Warning. If the CPU usage on the monitored appliance exceeds the Critical limit, the status classification for that module changes to Critical. That status data feeds into the health monitor.
 
    [bookmark: pgfId-3485410]The maximum percentage you can set for either limit is 100 percent, and the Critical limit must be higher than the Warning limit. 
 
    [bookmark: pgfId-5530463]To configure CPU usage limits:
 
    [bookmark: pgfId-4242157]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3351681]Step 1 On the Health Policy Configuration page, select CPU Usage.
 
    [bookmark: pgfId-3351682]The Health Policy Configuration — CPU Usage page appears.
 
    [bookmark: pgfId-3351687]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-3351688]Step 3 In the Critical Threshold % field, enter the percentage of CPU usage that should trigger a critical health status.
 
    [bookmark: pgfId-3351689]Step 4 In the Warning Threshold % field, enter the percentage of CPU usage that should trigger a warning health status.
 
    [bookmark: pgfId-3351690]Step 5 You have three options:
 
     
      
      	 [bookmark: pgfId-3351691]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-3351692]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-3351693]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-3351694]You must apply the health policy to the appropriate appliances if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611470]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4878009][bookmark: 62997]Configu[bookmark: marker-5005895]ring Card Reset Monitoring
 
    [bookmark: pgfId-5106199]License: Any
 
    [bookmark: pgfId-4878018]Use the card reset monitoring health status module to track when the network card restarts because of hardware failure. If a reset occurs, this module generates an alert. That status data feeds into the health monitor. 
 
    [bookmark: pgfId-4878019]To configure card reset monitoring:
 
    [bookmark: pgfId-4878020]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-4878024]Step 1 In the Health Policy Configuration page, select Card Reset. 
 
    [bookmark: pgfId-4878028]The Health Policy Configuration — Card Reset Monitoring page appears.
 
    [bookmark: pgfId-4878033]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-4878034]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-4878035]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-4878036]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-4878037]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-4878041]You must apply the health policy to the appropriate Defense Center if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611489]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5476463][bookmark: 36268][bookmark: 24858]Configuring Disk S[bookmark: marker-5510725]tatus Monitoring
 
    [bookmark: pgfId-5476532]License: Any
 
    [bookmark: pgfId-5476554]Use the Disk Status health module to monitor the current status of your appliance’s hard disk, and malware storage pack if installed. This module generates a Warning (yellow) health alert when the hard disk and RAID controller (if installed) are in danger of failing, or if an additional hard drive is installed that is not a malware storage pack. This module generates an Alert (red) health alert when an installed malware storage pack cannot be detected.
 
    [bookmark: pgfId-5476555]To configure Disk Status health module settings:
 
    [bookmark: pgfId-5476556]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5476557]Step 1 On the Health Policy Configuration page, click Disk Status.
 
    [bookmark: pgfId-5476558]The Health Policy Configuration — Disk Status page appears.
 
    [bookmark: pgfId-5476563]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5476564]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5476565]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5476566]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5476567]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5476568]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611555]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5476306][bookmark: 22463]Configuring [bookmark: marker-5476305]Disk Usage Monitoring
 
    [bookmark: pgfId-5476307]License: Any
 
    [bookmark: pgfId-3351860]Without sufficient disk space, an appliance cannot run. The health monitor can identify low disk space conditions on your appliance’s hard drive and malware storage pack before space runs out. The health monitor can also alert when hard drive file draining occurs too frequently. Use the Disk Usage health status module to monitor disk usage for the / and /volume partitions on the appliance and track draining frequency. 
 
     
      
    
 
    
 
    [bookmark: pgfId-5023338]Note Although the disk usage module lists the /boot partition as a monitored partition, the size of the partition is static so the module does not alert on the boot partition.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3351861]If the overall disk usage on the monitored appliance exceeds the Warning limit, the status classification for that module changes to Warning. If the overall disk usage on the monitored appliance exceeds the Critical limit, the status classification for that module changes to Critical. The maximum percentage you can set for either limit is 100 percent, and the Critical limit must be higher than the Warning limit. 
 
    [bookmark: pgfId-5537838]If the system deletes unprocessed events, the status classification for that module changes to Warning. If the system drains files in any disk usage category too frequently based on module thresholds, or if disk usage for files not in a monitored disk usage category grows too large based on module thresholds, the status classification for that module changes to Critical. For more information on disk usage categories, see Understanding the Disk Usage Widget.
 
    [bookmark: pgfId-3351862]To configure Disk Usage health module settings:
 
    [bookmark: pgfId-4242180]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3351863]Step 1 On the Health Policy Configuration page, select Disk Usage.
 
    [bookmark: pgfId-3351864]The Health Policy Configuration — Disk Usage page appears.
 
    [bookmark: pgfId-3351869]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-3351870]Step 3 In the Critical Threshold % field, enter the percentage of disk usage that should trigger a critical health status.
 
    [bookmark: pgfId-3351871]Step 4 In the Warning Threshold % field, enter the percentage of disk usage that should trigger a warning health status.
 
    [bookmark: pgfId-3351872]Step 5 You have three options:
 
     
      
      	 [bookmark: pgfId-3351873]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-3351874]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-3351875]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-3439662]You must apply the health policy to the appropriate appliances if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611603]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5378823][bookmark: 97352]Configuring FireAMP Status Monito[bookmark: marker-5418776]ring
 
    [bookmark: pgfId-5378874]License: Any
 
    [bookmark: pgfId-5414476]Use the FireAMP Status Monitor module to alert you in the following situations:
 
     
     	 [bookmark: pgfId-5414480]the Defense Center cannot connect to the Cisco cloud after an initial successful connection
 
     	 [bookmark: pgfId-5414481]you deregister a cloud connection using the FireAMP portal
 
     	 [bookmark: pgfId-5647635]your FireAMP Private Cloud is unable to communicate with the public Cisco cloud
 
    
 
    [bookmark: pgfId-5391547]In these cases, the module status changes to Critical and provides the cloud name associated with the failed connection. For information on configuring a cloud connection, see Working with Cloud Connections for FireAMP.
 
    [bookmark: pgfId-5390600]To configure FireAMP Status Monitor module settings:
 
    [bookmark: pgfId-5390601]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5390602]Step 1 In the Health Policy Configuration page, select FireAMP Status Monitor.
 
    [bookmark: pgfId-5390603]The Health Policy Configuration — FireAMP Status Monitor page appears.
 
    [bookmark: pgfId-5390608]Step 2 Select On for the Enabled option to enable use of the module for FireAMP status monitoring.
 
    [bookmark: pgfId-5390609]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5390610]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5390611]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5390612]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5390613]You must apply the health policy to the Defense Center if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611671]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5237101][bookmark: 94588]Configuring [bookmark: marker-5237097]FireSIGHT Host Usage Monitoring
 
    [bookmark: pgfId-5237112]License: FireSIGHT
 
    [bookmark: pgfId-5237120]Use the FireSIGHT Host License Limit health status module to set FireSIGHT Host amount warning limits. If the number of remaining FireSIGHT Hosts on the monitored device falls below the Warning Hosts limit, the status classification for that module changes to Warning. If the number of remaining FireSIGHT Hosts on the monitored device falls below the Critical Hosts limit, the status classification for that module changes to Critical. That status data feeds into the health monitor.
 
    [bookmark: pgfId-5237127]The maximum number of hosts you can set for either limit is 1000, and the Critical host limit number must be lower than the Warning limit. 
 
    [bookmark: pgfId-5237131]To configure FireSIGHT Host License Limit health module settings:
 
    [bookmark: pgfId-5237132]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5237136]Step 1 In the Health Policy Configuration page, select FireSIGHT Host License Limit.
 
    [bookmark: pgfId-5237140]The Health Policy Configuration — FireSIGHT Host License Limit page appears.
 
    [bookmark: pgfId-5237145]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5237146]Step 3 In the Critical number Hosts field, enter the remaining number of available hosts that should trigger a critical health status.
 
    [bookmark: pgfId-5237147]Step 4 In the Warning number Hosts field, enter the remaining number of available hosts that should trigger a warning health status.
 
    [bookmark: pgfId-5237148]Step 5 You have three options:
 
     
      
      	 [bookmark: pgfId-5237149]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5237150]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5237151]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5237152]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611687]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4776968][bookmark: 29888]Configuring [bookmark: marker-4776967]Hardware Alarm Monitoring
 
    [bookmark: pgfId-5106393]License: Any
 
    [bookmark: pgfId-5490328]Supported Devices: Series 3, 3D9900
 
    [bookmark: pgfId-4776977]Use the Hardware Alarms health status module to detect hardware failure on a Series 3 or 3D9900 device. If the Hardware Alarms module finds a hardware component that has failed or clustered devices that are not communicating with each other, the status classification for that module changes to Critical. That status data feeds into the health monitor.
 
    [bookmark: pgfId-5483170]For more information on the hardware status conditions that can cause hardware alerts on 3D9900 devices, see Interpreting Hardware Alert Details for 3D9900 Devices.
 
    [bookmark: pgfId-4776983]To configure Hardware Alarm health module settings:
 
    [bookmark: pgfId-4776984]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-4776985]Step 1 In the Health Policy Configuration page, select Hardware Alarms.
 
    [bookmark: pgfId-4776986]The Health Policy Configuration — Hardware Alarm Monitor page appears.
 
    [bookmark: pgfId-4776991]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-4776992]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-4776993]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-4776994]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-4776995]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5236407]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611710]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5236413][bookmark: 49349]Configuring Health Status Monitor[bookmark: marker-5236412]ing
 
    [bookmark: pgfId-5106413]License: Any
 
    [bookmark: pgfId-5034776]Use the Health Monitor Process module to monitor the health of the health monitor on a Defense Center by generating alerts when too many minutes elapse between health events received from monitored appliances. 
 
    [bookmark: pgfId-5035343]For example, if a Defense Center (myrtle.example.com) monitors a device (dogwood.example.com), you apply a health policy with the Health Monitor Process module enabled to myrtle.example.com. The Health Monitor Process module then reports events that indicate how many minutes have elapsed since the last event was received from dogwood.example.com.
 
    [bookmark: pgfId-5034673]You can configure the elapsed duration between events, in minutes, that causes an alert to be generated. If the wait exceeds the number of minutes configured in the Warning Minutes since last event limit, the status classification for that module changes to Warning. If the wait exceeds the Critical Minutes since last event limit, the status classification for that module changes to Critical. That status data feeds into the health monitor.
 
    [bookmark: pgfId-4832894]The maximum number of minutes you can set for either limit is 144, and the Critical limit must be higher than the Warning limit. The minimum number of minutes is 5.
 
    [bookmark: pgfId-4832898]To configure Health Monitor Process module settings:
 
    [bookmark: pgfId-4832899]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-4832903]Step 1 In the Health Policy Configuration page, select Health Monitor Process.
 
    [bookmark: pgfId-4833688]The Health Policy Configuration — Health Monitor Process page appears.
 
    [bookmark: pgfId-4833693]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-4832913]Step 3 In the Critical Minutes since last event field, enter the maximum number of minutes to wait between events, before triggering a critical health status.
 
    [bookmark: pgfId-4832914]Step 4 In the Warning Minutes since last event field, enter the maximum number of minutes to wait between events, before triggering a warning health status.
 
    [bookmark: pgfId-4832915]Step 5 You have three options:
 
     
      
      	 [bookmark: pgfId-4832916]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-4832917]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-4832918]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-4832922]You must apply the health policy to the Defense Center for your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611816]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5531537][bookmark: 43770]Configuring Inline Link Mismatch Alarm Monitoring
 
    [bookmark: pgfId-5531538]License: Any
 
    [bookmark: pgfId-5531539]Use the Inline Link Mismatch Alarm health status module to track when the interfaces on either side of an inline set negotiate different connection speeds. If different negotiated speeds are detected, this module generates an alert.
 
    [bookmark: pgfId-5531540]To configure inline link mismatch monitoring:
 
    [bookmark: pgfId-5531541]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5531542]Step 1 In the Health Policy Configuration page, select Inline Link Mismatch Alarms. 
 
    [bookmark: pgfId-5531543]The Health Policy Configuration — Inline Link Mismatch Alarms page appears.
 
    [bookmark: pgfId-5531548]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5531549]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5531550]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5531551]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5531552]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5532248]You must apply the health policy to the appropriate Defense Center if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5698214]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5698216][bookmark: 23497]Configuring [bookmark: marker-5698215]Interface Status Monitoring
 
    [bookmark: pgfId-5698223]License: FireSIGHT
 
    [bookmark: pgfId-5698020]Use the Interface Status health status module to detect whether a device receives traffic. If the Interface Status module determines that a device does not receive traffic, the status classification for that module changes to Critical. That status data feeds into the health monitor.
 
     
      
    
 
    
 
    [bookmark: pgfId-5698021]Note Interfaces labeled DataPlaneInterfacex, where x is a numerical value, are internal ASA interfaces (not user-defined) and involve packet flow within the system.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5698022]To configure Interface Status health module settings:
 
    [bookmark: pgfId-5698026]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5698027]Step 1 In the Health Policy Configuration page, select Interface Status.
 
    [bookmark: pgfId-5698028]The Health Policy Configuration — Interface Status page appears.
 
    [bookmark: pgfId-5698029]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5698030]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5698031]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5698032]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5698033]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5698034]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5698038]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5532255][bookmark: 20741]Configuring [bookmark: marker-5532254]Intrusion Event Rate Monitoring
 
    [bookmark: pgfId-5532238]License: Protection
 
    [bookmark: pgfId-3352124]Use the Intrusion Event Rate health status module to set limits for the number of packets per second that trigger a change in the health status. If the event rate on the monitored device exceeds the number of events per second configured in the Events per second (Warning) limit, the status classification for that module changes to Warning. If the event rate exceeds the number of events per second configured in the Events per second (Critical) limit, the status classification for that module changes to Critical. That status data feeds into the health monitor.
 
    [bookmark: pgfId-3352125]Typically, the event rate for a network segment averages 20 events per second. For a network segment with this average rate, Events per second (Critical) should be set to 50 and Events per second (Warning) should be set to 30. To determine limits for your system, find the Events/Sec value on the Statistics page for your device (System > Monitoring > Statistics), then calculate the limits using these formulas:
 
     
     	 [bookmark: pgfId-3352129]Events per second (Critical) = Events/Sec * 2.5
 
     	 [bookmark: pgfId-3352130]Events per second (Warning) = Events/Sec * 1.5
 
    
 
    [bookmark: pgfId-3489326]The maximum number of events you can set for either limit is 999, and the Critical limit must be higher than the Warning limit. 
 
    [bookmark: pgfId-3352131]To configure Intrusion Event Rate Monitor health module settings:
 
    [bookmark: pgfId-4242209]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3352132]Step 1 On the Health Policy Configuration page, select Intrusion Event Rate.
 
    [bookmark: pgfId-3352133]The Health Policy Configuration — Intrusion Event Rate page appears.
 
    [bookmark: pgfId-3550588]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-3352139]Step 3 In the Events per second (Critical) field, enter the number of events per second that should trigger a critical health status.
 
    [bookmark: pgfId-3352140]Step 4 In the Events per second (Warning) field, enter the number of events per second that should trigger a warning health status.
 
    [bookmark: pgfId-3352141]Step 5 You have three options:
 
     
      
      	 [bookmark: pgfId-3352142]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-3352143]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-3352144]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5261768]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611860]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5284983][bookmark: 82536]Understanding License Monito[bookmark: marker-5418799]ring
 
    [bookmark: pgfId-5284984]License: Any
 
    [bookmark: pgfId-5284985]Use the License Monitoring health status module to determine if sufficient licenses remain for Control, Protection, URL Filtering, Malware, and VPN. This module alerts if the number of remaining licenses is low or insufficient.
 
    [bookmark: pgfId-5523938]This module also alerts if the system detects that devices in a stacked configuration have mismatched license sets (stacked devices must have identical sets of licenses).
 
    [bookmark: pgfId-5285161]The License Monitoring module is automatically configured. Because you cannot change or disable this module, it does not appear on the Health Policy Configuration page.
 
   
 
    
     [bookmark: pgfId-5265860][bookmark: 12925]Configuring [bookmark: marker-5265859]Link State Propagation Monitoring
 
    [bookmark: pgfId-5106478]License: Any
 
    [bookmark: pgfId-5265851]Use the Link State Propagation health status module to detect the link state propagation status on an inline pair. If a link state propagates to the pair, the status classification for that module changes to Critical and the state reads:
 
     
     [bookmark: pgfId-5265842]Module Link State Propagation: ethx_ethy is Triggered 
    
 
    [bookmark: pgfId-5265843]where x and y are the paired interface numbers.
 
    [bookmark: pgfId-5265837]To configure Link State Propagation health module settings:
 
    [bookmark: pgfId-5265838]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5265832]Step 1 On the Health Policy Configuration page, select Link State Propagation.
 
    [bookmark: pgfId-5265833]The Health Policy Configuration — Link State Propagation monitor page appears.
 
    [bookmark: pgfId-4777245]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-4777246]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-4777247]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-4777248]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-4777249]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-4777250]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611890]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3352309][bookmark: 30682]Configuring [bookmark: marker-3750350]Memory Usage Monitoring
 
    [bookmark: pgfId-5106527]License: Any
 
    [bookmark: pgfId-3352311]Use the Memory Usage health status module to set memory usage limits. The module calculates free memory by considering free memory, cached memory, and swap memory. If the memory usage on the monitored appliance exceeds the Warning limit, the status classification for that module changes to Warning. If the memory usage on the monitored appliance exceeds the Critical limit, the status classification for that module changes to Critical. That status data feeds into the health monitor.
 
    [bookmark: pgfId-5374109]For appliances with more than 4GB of memory, the preset alert thresholds are based on a formula that accounts for proportions of available memory likely to cause system problems.
 
     
      
    
 
    
 
    [bookmark: pgfId-5374110]Note On <4GB appliances, because the interval between Warning and Critical thresholds may be very narrow, Cisco recommends that you manually set the Warning Threshold % value to 50. This will further ensure that you receive memory alerts for your appliance in time to address the issue.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3489401]The maximum percentage you can set for either limit is 100 percent, and the Critical limit must be higher than the Warning limit. 
 
     
      
    
 
    
 
    [bookmark: pgfId-5614840]Note If you apply an access control policy with many FireSIGHT features enabled (such as security intelligence, file capture, intrusion policies with many rules, or URL filtering), some lower-end ASA FirePOWER devices may generate intermittent memory usage warnings, as the device’s memory allocation is being used to the fullest extent possible.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5614844]To configure Memory Usage health module settings:
 
    [bookmark: pgfId-4242227]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3352313]Step 1 On the Health Policy Configuration page, select Memory Usage.
 
    [bookmark: pgfId-3352314]The Health Policy Configuration — Memory Usage page appears.
 
    [bookmark: pgfId-3352319]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-3352320]Step 3 In the Critical Threshold % field, enter the percentage of memory usage that should trigger a critical health status.
 
    [bookmark: pgfId-3352321]Step 4 In the Warning Threshold % field, enter the percentage of memory usage that should trigger a warning health status.
 
    [bookmark: pgfId-3352322]Step 5 You have three options:
 
     
      
      	 [bookmark: pgfId-3352323]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-3352324]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-3352325]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-3352326]You must apply the health policy to the appropriate appliances if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5611902]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-4777400][bookmark: 66866]Configuring [bookmark: marker-4777399]Power Supply Monitoring
 
    [bookmark: pgfId-5493651]License: Any
 
    [bookmark: pgfId-5493652]Supported Devices: 3D3500, 3D4500, 3D6500, 3D9900, Series 3
 
    [bookmark: pgfId-5514890]Supported Defense Centers: DC1500, DC2000, DC3500, DC4000
 
    [bookmark: pgfId-5108005]Use the Power Supply health status module to detect a power supply failure on any of the supported platforms. If the module finds a power supply that has no power, the status classification for that module changes to No Power. If the module cannot detect the presence of the power supply, the status changes to Critical Error. That status data feeds into the health monitor. You can expand the Power Supply item on the Alert Detail list in the health monitor to see specific status items for each power supply. 
 
    [bookmark: pgfId-4777422]To configure Power Supply health module settings:
 
    [bookmark: pgfId-4777423]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5197191]Step 1 In the Health Policy Configuration page, select Power Supply.
 
    [bookmark: pgfId-5197192]The Health Policy Configuration — Power Supply page appears.
 
    [bookmark: pgfId-4777430]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-4777431]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-4777432]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-4777433]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-4777434]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-4777435]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5612002]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5159993][bookmark: 48558]Configuring Process Sta[bookmark: marker-5418824]tus Monitoring
 
    [bookmark: pgfId-5160001]License: Any
 
    [bookmark: pgfId-5147421]Use the Process Status health module to monitor for processes running on the appliance that exit or terminate outside of the process manager. The response of the Process Status module to a process ending depends on how the process ends:
 
     
     	 [bookmark: pgfId-5171488]If the process terminates inside the process manager, the module does not report any health events.
 
     	 [bookmark: pgfId-5171481]If a process is deliberately exited outside of the process manager, the module status changes to Warning and the health event message indicates which process exited until the module runs again and the process has restarted. 
 
     	 [bookmark: pgfId-5171495]If a process terminates abnormally or crashes outside of the process manager, the module status changes to Critical and the health event message indicates the terminated process until the module runs again and the process has restarted.
 
    
 
    [bookmark: pgfId-5160018]To configure Process Status health module settings:
 
    [bookmark: pgfId-5160019]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5160020]Step 1 In the Health Policy Configuration page, select Process Status.
 
    [bookmark: pgfId-5160021]The Health Policy Configuration — Process Status page appears.
 
    [bookmark: pgfId-5160026]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5160027]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5160028]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5160029]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5160030]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5705509]You must apply the health policy to the appropriate appliances if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5706446]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5706448][bookmark: 47026]Configurin[bookmark: marker-5706447]g Reconfiguring Detection Monitoring
 
    [bookmark: pgfId-5706452]License: Any
 
    [bookmark: pgfId-5706767]Use the Reconfiguring Detection Monitor module to determine the status of detection capabilities after applying a policy to your managed devices. If a policy apply fails and detection ceases functionality, the module generates an alert in Health Events.
 
    [bookmark: pgfId-5706016]To configure time series data monitoring settings:
 
    [bookmark: pgfId-5706020]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5706021]Step 1 In the Health Policy Configuration page, select Reconfiguring Detection.
 
    [bookmark: pgfId-5706022]The Health Policy Configuration — Reconfiguring Detection page appears. 
 
    [bookmark: pgfId-5706023]Step 2 Select On for the Enabled option to enable use of the module for health alerts.
 
    [bookmark: pgfId-5706024]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5706025]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5706026]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5706027]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5706028]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5706032]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5706005][bookmark: 77529]Configuring RRD Server Process Monito[bookmark: marker-5705515]ring
 
    [bookmark: pgfId-5318482]License: Any
 
    [bookmark: pgfId-5318483]Use the RRD Server Process module to see if the RRD server that stores time series data is working properly. The module will alert If the RRD server has restarted since the last time it updated; it will enter Critical or Warning status if the number of consecutive updates with an RRD server restart reaches the numbers specified in the module configuration.
 
    [bookmark: pgfId-5318484]To configure RRD server process monitoring settings:
 
    [bookmark: pgfId-5318199]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5318200]Step 1 In the Health Policy Configuration page, select RRD Server Process.
 
    [bookmark: pgfId-5318315]The Health Policy Configuration — RRD Server Process page appears.
 
    [bookmark: pgfId-5318420]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5318634]Step 3 In the Critical Number of restarts field, enter the number of consecutive detected RRD server resets that should trigger a critical health status.
 
    [bookmark: pgfId-5319808]Step 4 In the Warning Number of restarts field, enter the number of consecutive detected RRD server resets that should trigger a warning health status.
 
    [bookmark: pgfId-5318494]Step 5 You have three options:
 
     
      
      	 [bookmark: pgfId-5318495]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5318496]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5318497]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5318498]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5612026]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5413368][bookmark: 56503]Configuring Security Intelligence Monitor[bookmark: marker-5418837]ing
 
    [bookmark: pgfId-5413369]License: Protection
 
    [bookmark: pgfId-5494933]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-5413370]Use the Security Intelligence module to warn you in a variety of situations involving Security Intelligence filtering. The module alerts if Security Intelligence is in use and:
 
     
     	 [bookmark: pgfId-5413374]the Defense Center cannot update a feed, or if feed data is corrupt or contains no recognizable IP addresses
 
     	 [bookmark: pgfId-5413375]a managed device had a problem receiving updated Security Intelligence data from the Defense Center
 
     	 [bookmark: pgfId-5413379]a managed device cannot load all of the Security Intelligence data provided to it by the Defense Center, due to memory issues
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-5493881]Tip If a Security Intelligence memory warning appears in the health monitor, you can reapply the affected device’s access control policy to increase the memory allocated to Security Intelligence; see Applying an Access Control Policy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5413385]For more information on Security Intelligence filtering, see Blacklisting Using Security Intelligence IP Address Reputation and Working with Security Intelligence Lists and Feeds.
 
    [bookmark: pgfId-5413393]To configure Security Intelligence module settings:
 
    [bookmark: pgfId-5413394]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5413395]Step 1 In the Health Policy Configuration page, select Security Intelligence.
 
    [bookmark: pgfId-5413396]The Health Policy Configuration — Security Intelligence page appears.
 
    [bookmark: pgfId-5413401]Step 2 Select On for the Enabled option to enable use of the module for Security Intelligence monitoring.
 
    [bookmark: pgfId-5413402]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5413403]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5413404]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5413405]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5413406]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5612058]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5316259][bookmark: 89282]Configurin[bookmark: marker-5418883]g Time Series Data Monitoring
 
    [bookmark: pgfId-5316260]License: Any
 
    [bookmark: pgfId-5316261]Use the Time Series Data Monitor module to monitor the status of time series data (such as lists of compliance events) that your system has stored. This module scans your time series data storage directory for corrupt files. If the module finds corrupted data, it enters a Warning status and reports the names of all affected files.
 
    [bookmark: pgfId-5316262]To configure time series data monitoring settings:
 
    [bookmark: pgfId-5316263]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5316264]Step 1 In the Health Policy Configuration page, select Time Series Data Monitor.
 
    [bookmark: pgfId-5316265]The Health Policy Configuration — Time Series Data Monitor page appears. 
 
    [bookmark: pgfId-5319894]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5318429]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5318430]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5318431]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5318432]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5318433]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5612074]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5279846][bookmark: 21299][bookmark: 38197][bookmark: 94653]Configuring[bookmark: marker-5279845] Time Synchronization Monitoring
 
    [bookmark: pgfId-5279852]License: Any
 
    [bookmark: pgfId-4796044]Use the Time Synchronization Status module to detect when the time on a managed device that uses NTP to obtain time from an NTP server differs by 10 seconds or more from the time on the server. 
 
    [bookmark: pgfId-4796210]To configure time synchronization monitoring settings:
 
    [bookmark: pgfId-4796211]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-4796212]Step 1 In the Health Policy Configuration page, select Time Synchronization Status.
 
    [bookmark: pgfId-4796213]The Health Policy Configuration — Time Synchronization Status page appears.
 
    [bookmark: pgfId-4796218]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-4796219]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-4796220]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-4796221]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-4796222]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-4796223]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5612105]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5227098][bookmark: 18628][bookmark: 68724]Configuring URL Filtering Mo[bookmark: marker-5458444]nitoring
 
    [bookmark: pgfId-5334086]License: URL Filtering
 
    [bookmark: pgfId-5514416]Supported Defense Centers: Any except DC500
 
    [bookmark: pgfId-5334087]Use the URL Filtering Monitor module to track communications between the Defense Center and the Cisco cloud, where the system obtains its URL filtering (category and reputation) data for commonly visited URLs. If the Defense Center fails to successfully communicate with or retrieve an update from the cloud, the status classification for that module changes to Critical.
 
    [bookmark: pgfId-5471242]In a high availability configuration, only the primary Defense Center communicates with the URL filtering cloud; all data from this module refers only to that primary appliance.
 
    [bookmark: pgfId-5345823]The URL Filtering Monitor module also tracks communications between the Defense Center and any managed devices where you have enabled URL filtering. If the Defense Center is successfully communicating with the cloud, the module status changes to Warning if the Defense Center cannot push new URL filtering data to its managed devices.
 
    [bookmark: pgfId-5345824]To configure URL Filtering Monitor health module settings:
 
    [bookmark: pgfId-5227445]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5227446]Step 1 In the Health Policy Configuration page, select URL Filtering Monitor.
 
    [bookmark: pgfId-5227447]The Health Policy Configuration — URL Filtering Monitor page appears.
 
    [bookmark: pgfId-5227570]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5227453]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5227454]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5227455]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5227456]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5227457]You must apply the health policy to the Defense Center if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5612227]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5378989][bookmark: 53036]Configuring User Agent Status[bookmark: marker-5418852] Monitoring
 
    [bookmark: pgfId-5379039]License: FireSIGHT
 
    [bookmark: pgfId-5407333]You can use the User Agent Status Monitor health module to monitor the heartbeat of agents connected to a Defense Center. If you enable the module in an applied health policy, the module generates a health alert if the Defense Center does not detect a heartbeat for any agent configured on the Defense Center.
 
    [bookmark: pgfId-5407995]To configure User Agent Status Monitor health module settings:
 
    [bookmark: pgfId-5407996]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5407997]Step 1 In the Health Policy Configuration page, select User Agent Status Monitor.
 
    [bookmark: pgfId-5407998]The Health Policy Configuration — User Agent Status Monitor page appears.
 
    [bookmark: pgfId-5408003]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5408004]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5408005]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5408006]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5408007]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5408011]You must apply the health policy to the Defense Center if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5612245]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5469656][bookmark: 67751]Configuring VPN Statu[bookmark: marker-5510774]s Monitoring
 
    [bookmark: pgfId-5469724]License: VPN
 
    [bookmark: pgfId-5495214]Supported Defense Centers: Any except Series 2
 
    [bookmark: pgfId-5469729]Use the VPN Status health module to monitor the current status of your configured Gateway VPN tunnels; information for each individual tunnel is displayed. This module generates a Critical (red) health alert when any of your VPN tunnels is not working.
 
    [bookmark: pgfId-5470053]To configure VPN Status health module settings:
 
    [bookmark: pgfId-5470156]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5470193]Step 1 On the Health Policy Configuration page, click VPN Status.
 
    [bookmark: pgfId-5470296]The Health Policy Configuration — VPN Status page appears.
 
    [bookmark: pgfId-5470497]Step 2 Select On for the Enabled option to enable use of the module for health status testing.
 
    [bookmark: pgfId-5470498]Step 3 You have three options:
 
     
      
      	 [bookmark: pgfId-5470499]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
      	 [bookmark: pgfId-5470500]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
      	 [bookmark: pgfId-5470501]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
     
 
    
 
    [bookmark: pgfId-5470502]You must apply the health policy to the appropriate devices if you want your settings to take effect. See Applying Health Policies for more information.
 
    [bookmark: pgfId-5612261]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5227104][bookmark: 82801][bookmark: 59539]Applying He[bookmark: marker-5227102]alth Policies
 
    [bookmark: pgfId-5612369]License: Any
 
    [bookmark: pgfId-3352906]When you apply a health policy to an appliance, the health tests for all the modules you enabled in the policy automatically monitor the health of the processes and hardware on the appliance. Health tests then continue to run at the intervals you configured in the policy, collecting health data for the appliance and forwarding that data to the Defense Center. 
 
    [bookmark: pgfId-3352910]If you enable a module in a health policy and then apply the policy to an appliance that does not require that health test, the health monitor reports the status for that health module as disabled.
 
    [bookmark: pgfId-3352911]If you apply a policy with all modules disabled to an appliance, it removes all applied health policies from the appliance so no health policy is applied. 
 
    [bookmark: pgfId-4834076]When you apply a different policy to an appliance that already has a policy applied, expect some latency in the display of new data based on the newly applied tests. 
 
     
      
    
 
    
 
    [bookmark: pgfId-3352915]Note Custom health policies created on Defense Centers in a high availability pair will be replicated between both appliances. However, changes to default health policies are not replicated; each appliance uses the local default health policy configured for that appliance.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3352926]To apply a health policy:
 
    [bookmark: pgfId-4242254]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3352927]Step 1 Select Health > Health Policy.
 
    [bookmark: pgfId-3352930]The Health Policy page appears.
 ) next to the policy you want to apply. 
    
 
    [bookmark: pgfId-3352940]The Health Policy Apply page appears. 
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-4999572]Step 3 Select the appliances where you want to apply the health policy.
 
   [bookmark: pgfId-3352946]Step 4 Click Apply to apply the policy to the selected appliances.
 
   [bookmark: pgfId-3352947]The Health Policy page appears, with a message indicating if the application of the policy was successful. Monitoring of the appliance starts as soon as the policy is successfully applied.
 
   [bookmark: pgfId-5612277]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-3352972][bookmark: 38256]Editing Hea[bookmark: marker-3352970]lth Policies
 
    [bookmark: pgfId-5612350]License: Any
 
    [bookmark: pgfId-3352973]You can modify a health policy by enabling or disabling modules or by changing module settings. If you modify a policy that is already applied to an appliance, the changes do not take effect until you reapply the policy. 
 
     
     [bookmark: pgfId-5160135]Module 
    
 
     
     [bookmark: pgfId-5160137]Applicable Appliance 
    
 
    [bookmark: pgfId-5443621]Advanced Malware Protection
 
    [bookmark: pgfId-5443623]Defense Centers, except DC500
 
    [bookmark: pgfId-5160139]Appliance Heartbeat
 
    [bookmark: pgfId-5160144]Defense Center
 
    [bookmark: pgfId-5160146]Automatic Application Bypass Status
 
    [bookmark: pgfId-5160151]Any managed device
 
    [bookmark: pgfId-5160157]CPU Usage
 
    [bookmark: pgfId-5160159]Any except 3D9900
 
    [bookmark: pgfId-5160161]Card Reset
 
    [bookmark: pgfId-5160163]Any managed device
 
    [bookmark: pgfId-5477212]Disk Status
 
    [bookmark: pgfId-5477214]Any
 
    [bookmark: pgfId-5160165]Disk Usage
 
    [bookmark: pgfId-5160167]Any
 
    [bookmark: pgfId-5379249]FireAMP Status Monitor
 
    [bookmark: pgfId-5379251]Defense Center
 
    [bookmark: pgfId-5237989]FireSIGHT Host License Limit
 
    [bookmark: pgfId-5237994]Defense Center
 
    [bookmark: pgfId-5160180]Hardware Alarms
 
    [bookmark: pgfId-5401764]Series 3, 3D9900
 
    [bookmark: pgfId-5160184]Health Monitor Process
 
    [bookmark: pgfId-5160189]Defense Center
 
    [bookmark: pgfId-5533390]Inline Link Mismatch Alarms
 
    [bookmark: pgfId-5533392]Any managed device
 
    [bookmark: pgfId-5699146]Interface Status 
 
    [bookmark: pgfId-5699148]Any managed device
 
    [bookmark: pgfId-5160194]Intrusion Event Rate
 
    [bookmark: pgfId-5160202]Managed devices with Protection
 
    [bookmark: pgfId-5285508]License Monitor
 
    [bookmark: pgfId-5285510]Defense Center
 
    [bookmark: pgfId-5160204]Link State Propagation
 
    [bookmark: pgfId-5160212]Managed devices with Protection
 
    [bookmark: pgfId-5160214]Memory Usage
 
    [bookmark: pgfId-5160216]Any
 
    [bookmark: pgfId-5160225]Power Supply
 
    [bookmark: pgfId-5160233]Defense Centers: DC1500, DC2000, DC3500, DC4000
 
    [bookmark: pgfId-5517074]Devices: 3D3500, 3D4500, 3D6500, 3D9900, Series 3
 
    [bookmark: pgfId-5160235]Process Status
 
    [bookmark: pgfId-5160237]Any
 
    [bookmark: pgfId-5706894]Reconfiguring Detection
 
    [bookmark: pgfId-5706896]Any
 
    [bookmark: pgfId-5318696]RRD Server Process
 
    [bookmark: pgfId-5318698]Defense Center
 
    [bookmark: pgfId-5413596]Security Intelligence
 
    [bookmark: pgfId-5413601]Defense Center, except DC500
 
    [bookmark: pgfId-5318700]Time Series Data Monitor
 
    [bookmark: pgfId-5318702]Defense Center
 
    [bookmark: pgfId-5160259]Time Synchronization Status
 
    [bookmark: pgfId-5160264]Any
 
    [bookmark: pgfId-5279975]URL Filtering Monitor
 
    [bookmark: pgfId-5279977]Defense Centers, except DC500
 
    [bookmark: pgfId-5379462]User Agent Status Monitor
 
    [bookmark: pgfId-5379464]Defense Center
 
    [bookmark: pgfId-5470854]VPN Status
 
    [bookmark: pgfId-5470856]Defense Center
 
   
 
   [bookmark: pgfId-3982907]To edit a health policy:
 
   [bookmark: pgfId-4242263]Access: Admin/Maint
 
   
 
   [bookmark: pgfId-3352976]Step 1 Select Health > Health Policy.
 
   [bookmark: pgfId-3352979]The Health Policy page appears.
 ) next to the policy you want to modify. 
   
 
   [bookmark: pgfId-3352989]The Health Policy Configuration page appears, with the Policy Run Time Interval settings selected. 
 
   [bookmark: pgfId-3352990]Step 3 Modify settings as needed, as described in the following sections:
 
    
     
     	 [bookmark: pgfId-5379750]Configuring Policy Run Time Intervals
 
     	 [bookmark: pgfId-5443790]Configuring Advanced Malware Protection Monitoring
 
     	 [bookmark: pgfId-5379754]Configuring Appliance Heartbeat Monitoring
 
     	 [bookmark: pgfId-5379758]Configuring Automatic Application Bypass Monitoring
 
     	 [bookmark: pgfId-5379762]Configuring CPU Usage Monitoring
 
     	 [bookmark: pgfId-5379766]Configuring Card Reset Monitoring
 
     	 [bookmark: pgfId-5477239]Configuring Disk Status Monitoring
 
     	 [bookmark: pgfId-5379774]Configuring Disk Usage Monitoring
 
     	 [bookmark: pgfId-5379778]Configuring FireAMP Status Monitoring
 
     	 [bookmark: pgfId-5379782]Configuring FireSIGHT Host Usage Monitoring
 
     	 [bookmark: pgfId-5379786]Configuring Hardware Alarm Monitoring
 
     	 [bookmark: pgfId-5379790]Configuring Health Status Monitoring
 
     	 [bookmark: pgfId-5533436]Configuring Inline Link Mismatch Alarm Monitoring
 
     	 [bookmark: pgfId-5717428]Configuring Interface Status Monitoring
 
     	 [bookmark: pgfId-5379798]Configuring Intrusion Event Rate Monitoring
 
     	 [bookmark: pgfId-5379802]Understanding License Monitoring
 
     	 [bookmark: pgfId-5379806]Configuring Link State Propagation Monitoring
 
     	 [bookmark: pgfId-5379810]Configuring Memory Usage Monitoring
 
     	 [bookmark: pgfId-5379814]Configuring Power Supply Monitoring
 
     	 [bookmark: pgfId-5379818]Configuring Process Status Monitoring
 
     	 [bookmark: pgfId-5706999]Configuring Reconfiguring Detection Monitoring
 
     	 [bookmark: pgfId-5379822]Configuring RRD Server Process Monitoring
 
     	 [bookmark: pgfId-5413693]Configuring Security Intelligence Monitoring
 
     	 [bookmark: pgfId-5379826]Configuring Time Series Data Monitoring
 
     	 [bookmark: pgfId-5379830]Configuring Time Synchronization Monitoring
 
     	 [bookmark: pgfId-5379834]Configuring URL Filtering Monitoring
 
     	 [bookmark: pgfId-5379842]Configuring User Agent Status Monitoring
 
     	 [bookmark: pgfId-5470893]Configuring VPN Status Monitoring
 
    
 
   
 
   [bookmark: pgfId-5379714]Step 4 You have three options:
 
    
     
     	 [bookmark: pgfId-4041399]To save your changes to this module and return to the Health Policy page, click  Save Policy and Exit .
 
     	 [bookmark: pgfId-4041400]To return to the Health Policy page without saving any of your settings for this module, click  Cancel .
 
     	 [bookmark: pgfId-4041401]To temporarily save your changes to this module and switch to another module’s settings to modify, select the other module from the list at the left of the page. If you click  Save Policy and Exit when you are done, all changes you made will be saved; if you click  Cancel , you discard all changes.
 
    
 
   
 
   [bookmark: pgfId-3353055]Step 5 Reapply the policy to the appropriate appliances as described in Applying Health Policies.
 
   [bookmark: pgfId-5612311]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-5207255][bookmark: 14509]Comparing Health Policies
 
    [bookmark: pgfId-5207324]License: Any
 
    [bookmark: pgfId-5212648]To review policy changes for compliance with your organization’s standards or to optimize health monitoring performance, you can examine the differences between two health policies. You can compare any two health policies or two revisions of the same health policy, for the health policies you can access. To quickly compare your active health policy to another, you can select the Running Configuration option. Optionally, after you compare, you can then generate a PDF report to record the differences between the two policies or policy revisions.
 
    [bookmark: pgfId-5207344]There are two tools you can use to compare health policies or health policy revisions:
 
     
     	 [bookmark: pgfId-5212689]The comparison view displays only the differences between two health policies or health policy revisions in a side-by-side format; the name of each policy or policy revision appears in the title bar on the left and right sides of the comparison view.
 
    
 
    [bookmark: pgfId-5207374]You can use this to view and navigate both policy revisions on the web interface, with their differences highlighted.
 
     
     	 [bookmark: pgfId-5207387]The comparison report creates a record of only the differences between two health policies or health policy revisions in a format similar to the health policy report, but in PDF format.
 
    
 
    [bookmark: pgfId-5207428]You can use this to save, copy, print and share your policy comparisons for further examination.
 
    [bookmark: pgfId-5207459]For more information on understanding and using the health policy comparison tools, see:
 
     
     	 [bookmark: pgfId-5207678]Using the Health Policy Comparison View
 
     	 [bookmark: pgfId-5208828]Using the Health Policy Comparison Report
 
    
 
   
 
    
     [bookmark: pgfId-5207504][bookmark: 76698]Using the Health Policy Comparison View
 
    [bookmark: pgfId-5612405]License: Any
 
    [bookmark: pgfId-5209539]The comparison view displays both health policies or policy revisions in a side-by-side format, with each policy or policy revision identified by name in the title bar on the left and right sides of the comparison view. The time of last modification and the last user to modify are displayed to the right of the policy name. Note that the Health Policy page displays the time a policy was last modified in local time, but the health policy report lists the time modified in UTC.
 
    [bookmark: pgfId-5209509]Differences between the two health policies or policy revisions are highlighted:
 
     
     	 [bookmark: pgfId-5209510]Blue indicates that the highlighted setting is different in the two policies or policy revisions, and the difference is noted in red text.
 
     	 [bookmark: pgfId-5207882]Green indicates that the highlighted setting appears in one policy or policy revision but not the other.
 
    
 
    [bookmark: pgfId-5352307]You can perform any of the actions in the following table.
 
     
      [bookmark: pgfId-5352340]
 
      
       
        
        [bookmark: pgfId-5352351]Table 68-4 [bookmark: 29195]Health Policy Comparison View Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-5352381]To... 
          
  
         	 
           
           [bookmark: pgfId-5352383]You can... 
          
  
        
 
         
         	[bookmark: pgfId-5352389]navigate individually through changes
  
         	[bookmark: pgfId-5352391]click Previous or Next above the title bar.
 number adjusts to identify which difference you are viewing.
  
        
 
         
         	[bookmark: pgfId-5352397]generate a new health policy comparison view
  
         	[bookmark: pgfId-5352399]click New Comparison.
 [bookmark: pgfId-5352400]The Select Comparison window appears. See Using the Health Policy Comparison Report for more information.
  
        
 
         
         	[bookmark: pgfId-5352405]generate a health policy comparison report
  
         	[bookmark: pgfId-5352407]click Comparison Report. 
 [bookmark: pgfId-5352408]The health policy comparison report creates a PDF containing information identical to the comparison view.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-5352342][bookmark: 72816]Using the Health Policy Comparison Report
 
    [bookmark: pgfId-5612424]License: Any
 
    [bookmark: pgfId-5208281]A health policy comparison report is a record of all differences between two health policies or two revisions of the same health policy identified by the health policy comparison view, presented as a PDF. You can use this report to further examine the differences between two health policy configurations and to save and disseminate your findings.
 
    [bookmark: pgfId-5208314]You can generate a health policy comparison report from the comparison view for any health policies to which you have access. Remember to commit any potential changes before you generate a health policy report; only committed changes appear in the report.
 
    [bookmark: pgfId-5212713]Depending on your configuration, a health policy comparison report can contain one or more sections. Each section uses the same format and provides the same level of detail. Note that the Value A and Value B columns represent the policies or policy revisions you configured in the comparison view.
 
     
      
    
 
    
 
    [bookmark: pgfId-5651340]Tip You can use a similar procedure to compare SSL, network analysis, intrusion, file, system, or access control policies.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5249457]To compare two health policies or two revisions of the same policy:
 
    [bookmark: pgfId-5249458]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5249459]Step 1 Select Health > Health Policy.
 
    [bookmark: pgfId-5208362]The Health Policy page appears.
 
    [bookmark: pgfId-5208363]Step 2 Click Compare Policies.
 
    [bookmark: pgfId-5208364]The Select Comparison window appears. 
 
    [bookmark: pgfId-5212880]Step 3 From the Compare Against drop-down list, select the type of comparison you want to make: 
 
     
      
      	 [bookmark: pgfId-5212881]To compare two different policies, select  Other Policy .
 
      	 [bookmark: pgfId-5212882]To compare two revisions of the same policy, select  Other Revision .
 
      	 [bookmark: pgfId-5212883]To compare another policy to the currently active policy, select  Running Configuration. 
 
     
 
    
 
    [bookmark: pgfId-5213047]Remember to commit any changes before you generate a health policy report; only committed changes appear in the report.
 
    [bookmark: pgfId-5208374]Step 4 Depending on the comparison type you selected, you have the following choices:
 
     
      
      	 [bookmark: pgfId-5208375]If you are comparing two different policies, select the policies you want to compare from the  Policy A  and  Policy B  drop-down lists.
 
      	 [bookmark: pgfId-5208376]If you are comparing two revisions of the same policy, select the policy from the  Policy drop-down list, then select the revisions you want to compare from the  Revision A  and  Revision B  drop-down lists.
 
      	 [bookmark: pgfId-5208377]If you are comparing the running configuration to another policy, select the second policy from the  Policy B  drop-down list.
 
     
 
    
 
    [bookmark: pgfId-5208378]Step 5 Click OK to display the health policy comparison view.
 
    [bookmark: pgfId-5208379]The comparison view appears.
 
    [bookmark: pgfId-5208381]Step 6 Click Comparison Report to generate the health policy comparison report. 
 
    [bookmark: pgfId-5208345]The health policy report appears. Depending on your browser settings, the report may appear in a pop-up window, or you may be prompted to save the report to your computer.
 
    [bookmark: pgfId-5612435]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3353079][bookmark: 82889]Deleting Healt[bookmark: marker-3353078]h Policies
 
    [bookmark: pgfId-5612506]License: Any
 
    [bookmark: pgfId-3353080]You can delete health policies that you no longer need. If you delete a policy that is still applied to an appliance, the policy settings remain in effect until you apply a different policy. In addition, if you delete a health policy that is applied to a device, any health monitoring alerts in effect for the device remain active until you disable the underlying associated alert response; see Enabling and Disabling Alert Responses.
 
     
      
    
 
    
 
    [bookmark: pgfId-3353084]Tip To stop health monitoring for an appliance, create a health policy with all modules disabled and apply it to the appliance. For more information on creating health policies, see Creating Health Policies. For more information on applying health policies, see Applying Health Policies. 
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3353091]To delete a health policy:
 
    [bookmark: pgfId-4242268]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-3353092]Step 1 Select Health > Health Policy.
 
    [bookmark: pgfId-5310334]The Health Policy page appears.
 ) next to the policy you want to delete. 
    
 
    [bookmark: pgfId-5310336]A message appears, indicating if the deletion was successful.
 
    [bookmark: pgfId-5612525]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3891546][bookmark: 73993]Using the Health Monitor Bla[bookmark: marker-4068826]cklist
 
    [bookmark: pgfId-5349795]License: Any
 
    [bookmark: pgfId-5058696]In the course of normal network maintenance, you disable appliances or make them temporarily unavailable. Because those outages are deliberate, you do not want the health status from those appliances to affect the summary health status on your Defense Center. 
 
    [bookmark: pgfId-5058703]You can use the health monitor blacklist feature to disable health monitoring status reporting on an appliance or module. For example, if you know that a segment of your network will be unavailable, you can temporarily disable health monitoring for a managed device on that segment to prevent the health status on the Defense Center from displaying a warning or critical state because of the lapsed connection to the device.
 
    [bookmark: pgfId-5058713]When you disable health monitoring status, health events are still generated, but they have a disabled status and do not affect the health status for the health monitor. If you remove the appliance or module from the blacklist, the events that were generated during the blacklisting continue to show a status of disabled.
 
    [bookmark: pgfId-5058714]To temporarily disable health events from an appliance, go to the blacklist configuration page and add an appliance to the blacklist. After the setting takes effect, the system no longer includes the blacklisted appliance when calculating the overall health status. The Health Monitor Appliance Status Summary lists the appliance as disabled.
 
    [bookmark: pgfId-5058715]At times it may be more practical to just blacklist an individual health monitoring module on an appliance. For example, when you run out of FireSIGHT host licenses on an appliance, you can blacklist the FireSIGHT Host License Limit status messages. 
 
    [bookmark: pgfId-5058723]Note that on the main Health Monitor page you can distinguish between appliances that are blacklisted if you expand to view the list of appliances with a particular status by clicking the arrow in that status row. For more information on expanding that view, see Using the Health Monitor.
 ) and a notation are visible after you expand the view for a blacklisted or partially blacklisted appliance. 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-5058734]Note On a Defense Center, Health Monitor blacklist settings are local configuration settings. Therefore, if you blacklist a device, then delete it and later re-register it with the Defense Center, the blacklist settings remain persistent. The newly re-registered device remains blacklisted.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5530595]For more information, see:
 
     
     	 [bookmark: pgfId-5530529]Blacklisting Health Policies or Appliances
 
     	 [bookmark: pgfId-5547961]Blacklisting an Appliance
 
     	 [bookmark: pgfId-5530646]Blacklisting a Health Policy Module
 
    
 
     
      [bookmark: pgfId-3891550][bookmark: 39620]Blacklisting Health Policies or Appliances
 
     [bookmark: pgfId-5612543]License: Any
 
     [bookmark: pgfId-5546030]If you want to set health events to disabled for all appliances with a particular health policy, you can blacklist the policy. If you need to disable the results of a group of appliances’ health monitoring, you can blacklist the group of appliances. After the blacklist settings take effect, the appliance shows as disabled in the Health Monitor Appliance Module Summary and Device Management page. Health events for the appliance have a status of disabled.
 
     [bookmark: pgfId-5546034]Note that if your Defense Center is in a high availability configuration, you can blacklist a managed device on one high availability peer and not the other. You can also blacklist the [bookmark: marker-5546035]high availability peer to cause it to mark events generated by it and the devices from which it receives health events as disabled. Defense Centers in a high availability pair have the option to completely or partially blacklist their peer.
 
     [bookmark: pgfId-5058825]To blacklist an entire health policy or group of appliances:
 
     [bookmark: pgfId-5058826]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-5058827]Step 1 Select Health > Blacklist.
 
     [bookmark: pgfId-5058830]The Blacklist page appears. 
 
     [bookmark: pgfId-5058833]Step 2 Use the drop-down list on the right to sort the list by group, policy, or model. (Groups on a Defense Center are managed devices.)
 
     [bookmark: pgfId-5320131]Note that appliances with some, but not all, health modules blacklisted will appear as (Partially Blacklisted). If you edit their blacklist status on the main blacklist page, you can either blacklist all modules on those appliances or remove all blacklisting. For information on blacklisting individual health modules on an appliance, see Blacklisting a Health Policy Module.
 
      
       
     
 
     
 
    
 
    
 
    [bookmark: pgfId-5058862]Step 3 You have two options: 
 
     
      
      	 [bookmark: pgfId-5320067]To blacklist all appliances in a group, model, or policy category, select the category, then click  Blacklist Selected Devices .
 
      	 [bookmark: pgfId-5320090]To clear blacklisting from all appliances in a group, model, or policy category, select the category, then click  Clear Blacklist on Selected Devices .
 
     
 
    
 
    [bookmark: pgfId-5058866]The page refreshes, now indicating the new blacklist state of the appliances.
 
    [bookmark: pgfId-5612558]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5033626][bookmark: 95392]Blacklisting an Appliance
 
    [bookmark: pgfId-5612609]License: Any
 
    [bookmark: pgfId-5058899]If you need to set the events and health status for an individual appliance to disabled, you can blacklist the appliance. After the blacklist settings take effect, the appliance shows as disabled in the Health Monitor Appliance Module Summary and health events for the appliance have a status of disabled.
 
    [bookmark: pgfId-5058900]To blacklist an individual appliance:
 
    [bookmark: pgfId-5058901]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5058902]Step 1 Select Health > Blacklist.
 
    [bookmark: pgfId-5058905]The Blacklist page appears. 
 
    [bookmark: pgfId-5058906]Step 2 Use the drop-down list on the right to sort the list by appliance group, model, or by policy.
 
    [bookmark: pgfId-5058910]Step 3 You have two options:
 
     
      
      	 [bookmark: pgfId-5320239]To blacklist all appliances in a group, model, or policy category, select the category, then click  Blacklist Selected Devices .
 
      	 [bookmark: pgfId-5320240]To clear blacklisting from all appliances in a group, model, or policy category, select the category, then click  Clear Blacklist on Selected Devices .
 
     
 
    
 
    [bookmark: pgfId-5058915]The page refreshes and indicates the new blacklist state of the appliances. Click Edit and see Blacklisting a Health Policy Module to blacklist individual health policy modules.
 
    [bookmark: pgfId-5612620]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3917590][bookmark: 88822]Blacklisti[bookmark: marker-4068827]ng a Health Policy Module
 
    [bookmark: pgfId-5612633]License: Any
 
    [bookmark: pgfId-5061442]You can blacklist individual health policy modules on appliances. You may want to do this to prevent events from the module from changing the status for the appliance to warning or critical. 
 
    [bookmark: pgfId-5306628]When any part of a module is blacklisted, the line for that module appears in boldface type in the Defense Center web interface.
 
     
      
    
 
    
 
    [bookmark: pgfId-5101186]Tip After the blacklist settings take effect, the appliance shows as Partially Blacklisted or All Modules Blacklisted on the Blacklist page and in the Appliance Health Monitor Module Status Summary, but only in expanded views on the main Appliance Status Summary page. Make sure that you keep track of individually blacklisted modules so you can reactivate them when you need them. You may miss necessary warning or critical messages if you accidentally leave a module disabled.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5059084]To blacklist an individual health policy module:
 
    [bookmark: pgfId-5059085]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-5059086]Step 1 Select Health > Blacklist.
 
    [bookmark: pgfId-5059089]The Blacklist page appears.
 
    [bookmark: pgfId-5059090]Step 2 Sort by Group, Policy, or Model, then click Edit to display the list of health policy modules for an appliance.
 
    [bookmark: pgfId-5104702]The health policy modules appear. 
 
    [bookmark: pgfId-5104707]Step 3 Select each module that you want to blacklist.
 
    [bookmark: pgfId-5059099]Step 4 Click Save.
 
    [bookmark: pgfId-5612644]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3353121][bookmark: 56255]Configuring Health Mon[bookmark: marker-3353120]itor Alerts
 
    [bookmark: pgfId-5612654]License: Any
 
    [bookmark: pgfId-3353123]You can set up alerts to notify you through email, through SNMP, or through the system log when the status changes for the modules in a health policy. You can associate an existing alert response with health event levels to trigger and alert when health events of a particular level occur. 
 
    [bookmark: pgfId-3353124]For example, if you are concerned that your appliances may run out of hard disk space, you can automatically send an email to a system administrator when the remaining disk space reaches the warning level. If the hard drive continues to fill, you can send a second email when the hard drive reaches the critical level. 
 
    [bookmark: pgfId-3353125]For more information, see the following topics:
 
     
     	 [bookmark: pgfId-3353133]Creating Health Monitor Alerts
 
     	 [bookmark: pgfId-3353137]Interpreting Health Monitor Alerts
 
     	 [bookmark: pgfId-3353141]Editing Health Monitor Alerts
 
     	 [bookmark: pgfId-3588133]Deleting Health Monitor Alerts
 
    
 
     
      [bookmark: pgfId-3353258][bookmark: 14220]Creating Health[bookmark: marker-3750384] Monitor Alerts
 
     [bookmark: pgfId-5106855]License: Any
 
     [bookmark: pgfId-3353259]When you create a health monitor alert, you create an association between a severity level, a health module, and an alert response. You can use an existing alert or configure a new one specifically to report on system health. When the severity level occurs for the selected module, the alert triggers.
 
     [bookmark: pgfId-5025757]Note that if you create or update a threshold in a way that duplicates an existing threshold, you are notified of the conflict. When duplicate thresholds exist, the health monitor uses the threshold that generates the fewest alerts and ignores the others. The timeout value for the threshold must be between 5 and 4,294,967,295 minutes.
 
     [bookmark: pgfId-5025758]To create health monitor alerts:
 
     [bookmark: pgfId-4157852]Access: Admin
 
     
 
     [bookmark: pgfId-3353264]Step 1 Select Health > Health Monitor Alerts.
 
     [bookmark: pgfId-3571911]The Health Monitor Alerts page appears.
 
     [bookmark: pgfId-5105106]Step 2 Type a name for the health alert in the Health Alert Name field.
 
     [bookmark: pgfId-3353273]Step 3 From the Severity list, select the severity level you want to use to trigger the alert.
 
     [bookmark: pgfId-3353274]Step 4 From the Module list, select the modules for which you want the alert to apply.
 
      
       
     
 
     
 
     [bookmark: pgfId-3353275]Tip To select multiple modules, press Shift + Ctrl and click the module names.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-3353276]Step 5 From the Alert list, select the alert response that you want to trigger when the selected severity level is reached.
 
      
       
     
 
     
 
     [bookmark: pgfId-3353277]Tip Click Alerts to open the Alerts page. For more information on creating alerts, see Working with Alert Responses.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5320605]Step 6 Optionally, in the Threshold Timeout field, type the number of minutes that should elapse before each threshold period ends and the threshold count resets. The default value is 5 minutes.
 
     [bookmark: pgfId-5213671]Note that even if the policy run time interval value is less than the threshold timeout value, the interval between two reported health events from a given module is always greater, such that if the threshold timeout is 8 minutes and the policy run time interval is 5 minutes, there will be a 10-minute interval (5 x 2) between reported events.
 
     [bookmark: pgfId-5213672]Step 7 Click Save to save the health alert.
 
     [bookmark: pgfId-3353282]A message appears, indicating if the alert configuration was successfully saved. The Active Health Alerts list now includes the alert you created.
 
     [bookmark: pgfId-5612684]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-3353304][bookmark: 99219]Interpreting[bookmark: marker-3750394] Health Monitor Alerts
 
     [bookmark: pgfId-5612673]License: Any
 
     [bookmark: pgfId-3353305]The alerts generated by the health monitor contain the following information:
 
      
      	 [bookmark: pgfId-3353306]Severity, which indicates the severity level of the alert. 
 
      	 [bookmark: pgfId-3353307]Module, which specifies the health module whose test results triggered the alert.
 
      	 [bookmark: pgfId-3353308]Description, which includes the health test results that triggered the alert.
 
     
 
      
      [bookmark: pgfId-3353323]Severity 
     
 
      
      [bookmark: pgfId-3353325]Description 
     
 
     [bookmark: pgfId-3353327]Critical
 
     [bookmark: pgfId-3353329]The health test results met the criteria to trigger a Critical alert status.
 
     [bookmark: pgfId-3353331]Warning
 
     [bookmark: pgfId-3353333]The health test results met the criteria to trigger a Warning alert status.
 
     [bookmark: pgfId-3353335]Normal
 
     [bookmark: pgfId-3353337]The health test results met the criteria to trigger a Normal alert status.
 
     [bookmark: pgfId-3353339]Error
 
     [bookmark: pgfId-3353341]The health test did not run.
 
     [bookmark: pgfId-4827368]Recovered
 
     [bookmark: pgfId-4827370]The health test results met the criteria to return to a normal alert status, following a Critical or Warning alert status. 
 
    
 
    [bookmark: pgfId-3353346]For more information on health modules, see Understanding Health Modules.
 
   
 
    
     [bookmark: pgfId-3353368][bookmark: 99891]Editing Health Monitor[bookmark: marker-3750395] Alerts
 
    [bookmark: pgfId-5612737]License: Any
 
    [bookmark: pgfId-3353369]You can edit existing health monitor alerts to change the severity level, health module, or alert response associated with the health monitor alert. 
 
    [bookmark: pgfId-3353370]To edit health monitor alerts:
 
    [bookmark: pgfId-4157874]Access: Admin
 
    
 
    [bookmark: pgfId-3353371]Step 1 Select Health > Health Monitor Alerts.
 
    [bookmark: pgfId-3353374]The Health Monitor Alerts page appears.
 
    [bookmark: pgfId-3407465]Step 2 Select the alert you want to modify in the Active Health Alerts list.
 
    [bookmark: pgfId-3407466]Step 3 Click Load to load the configured settings for the selected alert.
 
    [bookmark: pgfId-3407469]Step 4 Modify settings as needed. For more information, see Creating Health Monitor Alerts.
 
    [bookmark: pgfId-3353384]Step 5 Click Save to save the modified health alert.
 
    [bookmark: pgfId-5480302]A message appears, indicating if the alert configuration was successfully saved. 
 
    [bookmark: pgfId-5612771]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5480305][bookmark: 64625]Deleting Health[bookmark: marker-5480304] Monitor Alerts
 
    [bookmark: pgfId-5612760]License: Any
 
    [bookmark: pgfId-3353408]You can delete existing health monitor alerts. 
 
     
      
    
 
    
 
    [bookmark: pgfId-3353409]Note Deleting a health monitor alert does not delete the associated alert response. You must disable or delete the underlying alert response to ensure that alerting does not continue. For more information, see Enabling and Disabling Alert Responses and Deleting an Alert Response.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3353416]To delete health monitor alerts:
 
    [bookmark: pgfId-4157889]Access: Admin
 
    
 
    [bookmark: pgfId-3353417]Step 1 Select Health > Health Monitor Alerts.
 
    [bookmark: pgfId-3353420]The Health Monitor Alerts page appears.
 
    [bookmark: pgfId-3353421]Step 2 Select the alert you want to delete in the Active Health Alerts list.
 
    [bookmark: pgfId-3353422]Step 3 Click Delete.
 
    [bookmark: pgfId-3353423]A message appears, indicating if the alert configuration was successfully deleted. 
 
    [bookmark: pgfId-5612792]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-5177008][bookmark: 15259]Using the Health Moni[bookmark: marker-5177007]tor
 
    [bookmark: pgfId-5612781]License: Any
 
    [bookmark: pgfId-5177018]The Health Monitor page provides the compiled health status for all devices managed by the Defense Center, plus the Defense Center. The Status table provides a count of the managed appliances for this Defense Center by overall health status. The pie chart supplies another view of the health status breakdown, indicating the percentage of appliances currently in each health status category. 
 
    [bookmark: pgfId-5177029][bookmark: 41488]To use the health monitor:
 
    [bookmark: pgfId-5177030]Access: Admin/Maint/Any Security Analyst
 
    
 
    [bookmark: pgfId-5177031]Step 1 Click Health > Health Monitor.
 
    [bookmark: pgfId-5177032]The Health Monitor page appears. 
 
    [bookmark: pgfId-5177037]Step 2 Select the appropriate status in the Status column of the table or the appropriate portion of the pie chart to the list appliances with that status. 
 
     
      
    
 
    
 
    [bookmark: pgfId-5177038]Tip If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5177039]The following topics provide details on the tasks you can perform from the Health Monitor page:
 
     
     	 [bookmark: pgfId-5177043]Interpreting Health Monitor Status
 
     	 [bookmark: pgfId-5177047]Using Appliance Health Monitors
 
     	 [bookmark: pgfId-5177051]Configuring Health Policies
 
     	 [bookmark: pgfId-5177055]Configuring Health Monitor Alerts
 
    
 
    [bookmark: pgfId-5612821]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-5177058][bookmark: 50428]Interpreting Health Monitor[bookmark: marker-5177057] Status
 
     [bookmark: pgfId-5612806]License: Any
 
     [bookmark: pgfId-5177059]Available status categories, by severity, include Error, Critical, Warning, Normal, Recovered, and Disabled, as described in the following table.
 
      
       [bookmark: pgfId-5177150]
 
       
        
         
         [bookmark: pgfId-5177069]Table 68-6 [bookmark: 41634]Health Status Indicator 
 
         
         
          
          	 
            
            [bookmark: pgfId-5177077]Status Level 
           
  
          	 
            
            [bookmark: pgfId-5177079]Status Icon 
           
  
          	 
            
            [bookmark: pgfId-5177081]Status Color 
           
  
          	 
            
            [bookmark: pgfId-5177083]Description 
           
  
         
 
          
          	[bookmark: pgfId-5177085]Error
  
          	 [bookmark: pgfId-5177090][image: ] 
  
          	[bookmark: pgfId-5177092]White
  
          	[bookmark: pgfId-5177094]Indicates that at least one health monitoring module has failed on the appliance and has not been successfully re-run since the failure occurred. Contact your technical support representative to obtain an update to the health monitoring module.
  
         
 
          
          	[bookmark: pgfId-5177096]Critical
  
          	 [bookmark: pgfId-5177101][image: ] 
  
          	[bookmark: pgfId-5177103]Red
  
          	[bookmark: pgfId-5177105]Indicates that the critical limits have been exceeded for at least one health module on the appliance and the problem has not been corrected.
  
         
 
          
          	[bookmark: pgfId-5177107]Warning
  
          	 [bookmark: pgfId-5177112][image: ] 
  
          	[bookmark: pgfId-5177114]Yellow
  
          	[bookmark: pgfId-5177116]Indicates that warning limits have been exceeded for at least one health module on the appliance and the problem has not been corrected.
  
         
 
          
          	[bookmark: pgfId-5177118]Normal
  
          	 [bookmark: pgfId-5177123][image: ] 
  
          	[bookmark: pgfId-5177125]Green
  
          	[bookmark: pgfId-5177127]Indicates that all health modules on the appliance are running within the limits configured in the health policy applied to the appliance.
  
         
 
          
          	[bookmark: pgfId-5177129]Recovered
  
          	 [bookmark: pgfId-5177134][image: ] 
  
          	[bookmark: pgfId-5177136]Green
  
          	[bookmark: pgfId-5177138]Indicates that all health modules on the appliance are running within the limits configured in the health policy applied to the appliance, including modules that were in a Critical or Warning state.
  
         
 
          
          	[bookmark: pgfId-5177140]Disabled
  
          	 [bookmark: pgfId-5177145][image: ] 
  
          	[bookmark: pgfId-5177147]Blue
  
          	[bookmark: pgfId-5177149]Indicates that an appliance is disabled or blacklisted, that the appliance does not have a health policy applied to it, or that the appliance is currently unreachable. 
  
         
 
         
       
 
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-5227929][bookmark: 76275]Using Appliance He[bookmark: marker-5227928]alth Monitors
 
    [bookmark: pgfId-5612831]License: Any
 
    [bookmark: pgfId-5472460]The Appliance health monitor provides a detailed view of the health status of an appliance.
 
     
      
    
 
    
 
    [bookmark: pgfId-5472546]Note Your session normally logs you out after 1 hour of inactivity (or another configured interval). If you plan to passively monitor the health monitor for long periods of time, consider exempting some users from session timeout, or changing the system timeout settings. For more information, see Managing User Login Settings and Configuring User Interface Settings.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5472462]To view the status summary for a specific appliance:
 
    [bookmark: pgfId-5177167]Access: Admin/Maint/Any Security Analyst
 
    
 
    [bookmark: pgfId-5177168]Step 1 Select Health > Health Monitor.
 
    [bookmark: pgfId-5177169]The Health Monitor page appears.
 
    [bookmark: pgfId-5177170]Step 2 To show the list of appliances with a particular status, click the arrow in that status row. 
 
     
      
    
 
    
 
    [bookmark: pgfId-5177171]Tip If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-5177172]Step 3 In the Appliance column of the appliance list, click the name of the appliance for which you want to view details in the health monitor toolbar.
 
    [bookmark: pgfId-5177173]The Health Monitor Appliance page appears.
 
    [bookmark: pgfId-5177178]Step 4 Optionally, in the Module Status Summary graph, click the color for the event status category you want to view. The Alert Detail list toggles the display to show or hide events. 
 
    [bookmark: pgfId-5177179]For more information, see the following sections:
 
     
      
      	 [bookmark: pgfId-5239132]Understanding Health Modules
 
      	 [bookmark: pgfId-5239136]Interpreting Health Monitor Status
 
      	 [bookmark: pgfId-5239140]Viewing Alerts by Status
 
      	 [bookmark: pgfId-5177191]Running All Modules for an Appliance
 
      	 [bookmark: pgfId-5177195]Running a Specific Health Module
 
      	 [bookmark: pgfId-5177199]Generating Health Module Alert Graphs
 
      	 [bookmark: pgfId-5177203]Using the Health Monitor to Troubleshoot
 
     
 
    
 
    [bookmark: pgfId-5612842]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-5177300][bookmark: 82697]Viewing Alerts by Status
 
     [bookmark: pgfId-5612885]License: Any
 
     [bookmark: pgfId-5177309]You can show or hide categories of alerts by status. 
 
     [bookmark: pgfId-5177310]To show alerts by status:
 
     [bookmark: pgfId-5196855]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177312]Step 1 Click the status icon or the color segment in the pie chart that corresponds to the health status of the alerts you want to view. The alerts for that category appear in the Alert Detail list.
 
     [bookmark: pgfId-5612969]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5177313]To hide alerts by status:
 
     [bookmark: pgfId-5177314]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177315]Step 1 Click the status icon or the color segment in the pie chart that corresponds to the health status of the alerts you want to view. The alerts in the Alert Detail list for that category disappear.
 
     [bookmark: pgfId-5612939]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5177318][bookmark: 22521]Running All Modules for an[bookmark: marker-5177317] Appliance
 
     [bookmark: pgfId-5612916]License: Any
 
     [bookmark: pgfId-5177327]Health module tests run automatically at the policy run time interval you configure when you create a health policy. However, you can also run all health module tests on demand to collect up-to-date health information for the appliance.
 
     [bookmark: pgfId-5177328]To run all health modules for the appliance:
 
     [bookmark: pgfId-5177329]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177330]Step 1 Select Health > Health Monitor.
 
     [bookmark: pgfId-5177331]The Health Monitor page appears.
 
     [bookmark: pgfId-5177332]Step 2 To expand the appliance list to show appliances with a particular status, click the arrow in that status row. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5177333]Tip If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5177334]Step 3 In the Appliance column of the appliance list, click the name of the appliance for which you want to view details.
 
     [bookmark: pgfId-5177335]The Health Monitor Appliance page appears.
 
     [bookmark: pgfId-5177340]Step 4 Click Run All Modules.
 
     [bookmark: pgfId-5177341]The status bar indicates the progress of the tests, then the Health Monitor Appliance page refreshes.
 
      
       
     
 
     
 
     [bookmark: pgfId-5177342]Note When you manually run health modules, the first refresh that automatically occurs may not reflect the data from the manually run tests. If the value has not changed for a module that you just ran manually, wait a few seconds, then refresh the page by clicking the device name. You can also wait for the page to refresh again automatically. 
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5612999]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5177345][bookmark: 33829]Running a[bookmark: marker-5177344] Specific Health Module
 
     [bookmark: pgfId-5613025]License: Any
 
     [bookmark: pgfId-5177354]Health module tests run automatically at the policy run time interval you configure when you create a health policy. However, you can also run a health module test on demand to collect up-to-date health information for that module.
 
     [bookmark: pgfId-5177355]To run a specific health module:
 
     [bookmark: pgfId-5177356]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177357]Step 1 Select Health > Health Monitor.
 
     [bookmark: pgfId-5177358]The Health Monitor page appears.
 
     [bookmark: pgfId-5177359]Step 2 To expand the appliance list to show appliances with a particular status, click the arrow in that status row. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5177360]Tip If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5177361]Step 3 In the Appliance column of the appliance list, click the name of the appliance for which you want to view details.
 
     [bookmark: pgfId-5177362]The Health Monitor Appliance page appears.
 
     [bookmark: pgfId-5177363]Step 4 In the Module Status Summary graph of the Health Monitor Appliance page, click the color for the health alert status category you want to view. 
 
     [bookmark: pgfId-5177364]The Alert Detail list expands to list the health alerts for the selected appliance for that status category. 
 
     [bookmark: pgfId-5177369]Step 5 In the Alert Detail row for the alert for which you want to view a list of events, click Run.
 
     [bookmark: pgfId-5177370]The status bar indicates the progress of the test, then the Health Monitor Appliance page refreshes.
 
      
       
     
 
     
 
     [bookmark: pgfId-5177371]Note When you manually run health modules, the first refresh that automatically occurs may not reflect the data from the manually run tests. If the value has not changed for a module that you just manually ran, wait a few seconds, then refresh the page by clicking the device name. You can also wait for the page to refresh automatically again.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5613044]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5177374][bookmark: 65661]Generating Health Mod[bookmark: marker-5177373]ule Alert Graphs
 
     [bookmark: pgfId-5613083]License: Any
 
     [bookmark: pgfId-5177383]You can graph the results over a period of time of a particular health test for a specific appliance. 
 
     [bookmark: pgfId-5177384]To generate a health module alert graph:
 
     [bookmark: pgfId-5177385]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177386]Step 1 Select Health > Health Monitor.
 
     [bookmark: pgfId-5177387]The Health Monitor page appears.
 
     [bookmark: pgfId-5177388]Step 2 To expand the appliance list to show appliances with a particular status, click the arrow in that status row. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5177389]Tip If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5177390]Step 3 In the Appliance column of the appliance list, click the name of the appliance for which you want to view details.
 
     [bookmark: pgfId-5177391]The Health Monitor Appliance page appears.
 
     [bookmark: pgfId-5177392]Step 4 In the Module Status Summary graph of the Health Monitor Appliance page, click the color for the health alert status category you want to view. 
 
     [bookmark: pgfId-5177393]The Alert Detail list expands to list the health alerts for the selected appliance for that status category. 
 
     [bookmark: pgfId-5177394]Step 5 In the Alert Detail row for the alert for which you want to view a list of events, click Graph.
 
     [bookmark: pgfId-5177395]A graph appears, showing the status of the event over time. The Alert Detail section below the graph lists all health alerts for the selected appliance.
 
      
       
     
 
     
 
     [bookmark: pgfId-5177398]Tip If no events appear, you may need to adjust the time range. See Setting Event Time Constraints for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5613114]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5177406][bookmark: 39308]Using the Health Monitor to Troubleshoot
 
     [bookmark: pgfId-5613142]License: Any
 
     [bookmark: pgfId-5177418]In some cases, if you have a problem with your appliance, Support may ask you to generate troubleshooting files to help them diagnose the problem. You can select any of the options listed in the following table to customize the troubleshooting data that the health monitor reports.
 
      
       [bookmark: pgfId-5183389]
 
       
        
         
         [bookmark: pgfId-5183619]Table 68-7 [bookmark: 45846]Selectable Troubleshoot Options 
 
         
         
          
          	 
            
            [bookmark: pgfId-5183623]This option... 
           
  
          	 
            
            [bookmark: pgfId-5183625]Reports... 
           
  
         
 
          
          	[bookmark: pgfId-5498914]Snort Performance and Configuration
  
          	[bookmark: pgfId-5498916]data and configuration settings related to Snort on the appliance
  
         
 
          
          	[bookmark: pgfId-5183627]Hardware Performance and Logs
  
          	[bookmark: pgfId-5183629]data and logs related to the performance of the appliance hardware
  
         
 
          
          	[bookmark: pgfId-5183631]System Configuration, Policy, and Logs
  
          	[bookmark: pgfId-5183633]configuration settings, data, and logs related to the current system configuration of the appliance
  
         
 
          
          	[bookmark: pgfId-5183635]Detection Configuration, Policy, and Logs
  
          	[bookmark: pgfId-5183637]configuration settings, data, and logs related to detection on the appliance
  
         
 
          
          	[bookmark: pgfId-5183639]Interface and Network Related Data
  
          	[bookmark: pgfId-5183641]configuration settings, data, and logs related to inline sets and network configuration of the appliance
  
         
 
          
          	[bookmark: pgfId-5183643]Discovery, Awareness, VDB Data, and Logs
  
          	[bookmark: pgfId-5183645]configuration settings, data, and logs related to the current discovery and awareness configuration on the appliance
  
         
 
          
          	[bookmark: pgfId-5183647]Upgrade Data and Logs
  
          	[bookmark: pgfId-5183649]data and logs related to prior upgrades of the appliance
  
         
 
          
          	[bookmark: pgfId-5183651]All Database Data
  
          	[bookmark: pgfId-5183653]all database-related data that is included in a troubleshoot report
  
         
 
          
          	[bookmark: pgfId-5183655]All Log Data
  
          	[bookmark: pgfId-5183657]all logs collected by the appliance database
  
         
 
          
          	[bookmark: pgfId-5355473]Network Map Information
  
          	[bookmark: pgfId-5355475]current network topology data
  
         
 
         
       
 
      
 
      [bookmark: pgfId-5183852]Note that some options overlap in terms of the data they report, but the troubleshooting files will not contain redundant copies, regardless of what options you select.
 
      [bookmark: pgfId-5183959]For more information, see the following sections:
 
       
        
        	 [bookmark: pgfId-5183976]Generating Appliance Troubleshooting Files
 
        	 [bookmark: pgfId-5183990]Downloading Troubleshooting Files
 
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-5183853][bookmark: 92961]Generating Appliance Troubleshooting Files
 
     [bookmark: pgfId-5613165]License: Any
 
     [bookmark: pgfId-5184374]Use the following procedure to generate customized troubleshooting files that you can send to Support. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5689492]Note You cannot use the primary Defense Center in a high availability configuration to generate troubleshooting files for the secondary Defense Center, or visa versa. You must generate troubleshooting files for a Defense Center from its own web interface.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5177419]To generate troubleshooting files:
 
     [bookmark: pgfId-5177420]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177421]Step 1 Select Health > Health Monitor.
 
     [bookmark: pgfId-5177422]The Health Monitor page appears.
 
     [bookmark: pgfId-5177423]Step 2 To expand the appliance list to show appliances with a particular status, click the arrow in that status row. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5177424]Tip If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5239570]Step 3 In the Appliance column of the appliance list, click the name of the appliance for which you want to view details.
 
     [bookmark: pgfId-5239571]The Health Monitor Appliance page appears.
 
     [bookmark: pgfId-5182425]Step 4 Click Generate Troubleshooting Files.
 
     [bookmark: pgfId-5309683]The Troubleshooting Options pop-up window appears.
 
     [bookmark: pgfId-5321140]Step 5 Select All Data to generate all possible troubleshooting data, or select individual check boxes to customize your report. For more information, see the Selectable Troubleshoot Options table.
 
     [bookmark: pgfId-5182476]Step 6 Click OK.
 
     [bookmark: pgfId-5184066]The Defense Center generates the troubleshooting files. You can monitor the file generation process in the task queue (System > Monitoring > Task Status).
 
     [bookmark: pgfId-5184067]Step 7 Continue with the procedure in the next section, Downloading Troubleshooting Files.
 
     [bookmark: pgfId-5613188]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5184069][bookmark: 54370]Downloading Troubleshooting Files
 
     [bookmark: pgfId-5613206]License: Any
 
     [bookmark: pgfId-5184415]Use the following procedure to download copies of your generated troubleshooting files.
 
     [bookmark: pgfId-5182620]To download troubleshooting files:
 
     [bookmark: pgfId-5182621]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5182639]Step 1 Select System > Monitoring > Task Status.
 
     [bookmark: pgfId-5183048]The Task Status page appears.
 
     [bookmark: pgfId-5558804]Step 2 Find the task that corresponds to the troubleshooting files you generated.
 
     [bookmark: pgfId-5177436]Step 3 After the appliance generates the troubleshooting files and the task status changes to Completed, click Click to retrieve generated files.
 
     [bookmark: pgfId-5177438]Step 4 Follow your browser’s prompts to download the files. 
 
     [bookmark: pgfId-5183919]The files are downloaded in a single .tar.gz file.
 
     [bookmark: pgfId-5177439]Step 5 Follow the directions from Support to send the troubleshooting files to Cisco.
 
     [bookmark: pgfId-5613270]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-5177444][bookmark: 85420]Working with He[bookmark: marker-5177442]alth Events
 
    [bookmark: pgfId-5613259]License: Any
 
    [bookmark: pgfId-5177450]The Defense Center provides fully customizable event views that allow you to quickly and easily analyze the health status events gathered by the health monitor. These event views allow you to search and view event data and to easily access other information that may be related to the events you are investigating. 
 
    [bookmark: pgfId-5177451]Many functions that you can perform on the health event view pages are constant across all event view pages. See Understanding Health Event Views for more information about these common procedures.
 
    [bookmark: pgfId-5177455]From the Health > Health Events menu option, you can view health events and can search for specific events.
 
    [bookmark: pgfId-5177456]See the following sections for more information about viewing events:
 
     
     	 [bookmark: pgfId-5177460]Understanding Health Event Views describes the types of events that FireSIGHT generates.
 
     	 [bookmark: pgfId-5177467]Viewing Health Events describes how to access and use the Event View page.
 
     	 [bookmark: pgfId-5177471]Searching for Health Events describes how to search for specific events using the Event Search page.
 
    
 
     
      [bookmark: pgfId-5177474][bookmark: 85452]Understanding Health Even[bookmark: marker-5177473]t Views
 
     [bookmark: pgfId-5613244]License: Any
 
     [bookmark: pgfId-5177478]The Defense Center health monitor logs health events, which you can see on the Health Event View page. If you understand what conditions each health module tests for, you can more effectively configure alerting for health events. For more information on the different types of health modules that generate health events, see Understanding Health Modules.
 
     [bookmark: pgfId-5177482]For more information about viewing and searching for health events, see the following sections:
 
      
      	 [bookmark: pgfId-5177486]Viewing Health Events
 
      	 [bookmark: pgfId-5177490]Understanding the Health Events Table
 
      	 [bookmark: pgfId-5177494]Searching for Health Events
 
     
 
    
 
     
      [bookmark: pgfId-5177497][bookmark: 57982]View[bookmark: marker-5177496]ing Health Events
 
     [bookmark: pgfId-5613225]License: Any
 
     [bookmark: pgfId-5177498]You can view the appliance health data collected by your health monitor in several ways. 
 
     [bookmark: pgfId-5177499]For more information, see the following topics:
 
      
      	 [bookmark: pgfId-5177503]Viewing All Health Events
 
      	 [bookmark: pgfId-5177507]Viewing Health Events by Module and Appliance
 
      	 [bookmark: pgfId-5177511]Working with the Health Events Table View
 
      	 [bookmark: pgfId-5518459]Interpreting Hardware Alert Details for 3D9900 Devices
 
      	 [bookmark: pgfId-5177515]Interpreting Hardware Alert Details for Series 3 Devices 
 
     
 
    
 
     
      [bookmark: pgfId-5177517][bookmark: 98550]Viewing All Health Events
 
     [bookmark: pgfId-5613304]License: Any
 
     [bookmark: pgfId-5177526]The Table View of Health Events page provides a list of all health events on the selected appliance. For a description of the health modules that generated the events that you may see on this page, see Understanding Health Modules.
 
     [bookmark: pgfId-5177532]When you access health events from the Health Monitor page on your Defense Center, you retrieve all health events for all managed appliances.
 
     [bookmark: pgfId-5177534]To view all health events on all managed appliances:
 
     [bookmark: pgfId-5177535]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177536]Step 1 Select Health > Health Events.
 
     [bookmark: pgfId-5177539]The Events page appears, containing all health events.
 
      
       
     
 
     
 
     [bookmark: pgfId-5177544]Note If no events appear, you may need to adjust the time range. See Setting Event Time Constraints for more information.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5613315]
 
      
      
 
     
 
     
 
      
       
     
 
     
 
     [bookmark: pgfId-5177548]Tip You can bookmark this view to allow you to return to the page in the health events workflow containing the Health Events table of events. The bookmarked view retrieves events within the time range you are currently viewing, but you can then modify the time range to update the table with more recent information if needed. For more information, see Setting Event Time Constraints.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5177553][bookmark: 13138]Viewing Health Events by Module and Appliance
 
     [bookmark: pgfId-5613289]License: Any
 
     [bookmark: pgfId-5177562]You can query for events generated by a specific health module on a specific appliance. 
 
     [bookmark: pgfId-5177563]To view the health events for a specific module:
 
     [bookmark: pgfId-5177564]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177565]Step 1 Select Health > Health Monitor.
 
     [bookmark: pgfId-5177566]The Health Monitor page appears.
 
     [bookmark: pgfId-5177567]Step 2 To expand the appliance list to show appliances with a particular status, click the arrow in that status row. 
 
      
       
     
 
     
 
     [bookmark: pgfId-5177568]Tip If the arrow in the row for a status level points down, the appliance list for that status shows in the lower table. If the arrow points right, the appliance list is hidden.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5177569]Step 3 In the Appliance column of the appliance list, click the name of the appliance for which you want to view details.
 
     [bookmark: pgfId-5177570]The Health Monitor Appliance page appears.
 
     [bookmark: pgfId-5177571]Step 4 In the Module Status Summary graph of the Health Monitor Appliance page, click the color for the health alert status category you want to view. 
 
     [bookmark: pgfId-5177572]The Alert Detail list expands to list the health alerts for the selected appliance for that status category. 
 
     [bookmark: pgfId-5177573]Step 5 In the Alert Detail row for the alert for which you want to view a list of events, click Events.
 
     [bookmark: pgfId-5177574]The Health Events page appears, containing query results for a query with the name of the appliance and the name of the selected health alert module as constraints.
 
     [bookmark: pgfId-5177581]If no events appear, you may need to adjust the time range. See Setting Event Time Constraints for more information.
 
     [bookmark: pgfId-5177583]Step 6 If you want to view all health events for the selected appliance, expand Search Constraints and click the Module Name constraint to remove it.
 
     [bookmark: pgfId-5613321]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5177585][bookmark: 52626]Working with the Health Events Table View
 
     [bookmark: pgfId-5613344]License: Any
 
     [bookmark: pgfId-5177594]The following table describes each action you can perform from the Event View page.
 
      
       [bookmark: pgfId-5177692]
 
       
        
         
         [bookmark: pgfId-5177601]Table 68-8 [bookmark: 48162]Health Event View Functions 
 
         
         
          
          	 
            
            [bookmark: pgfId-5177605]To... 
           
  
          	 
            
            [bookmark: pgfId-5177607]You can... 
           
  
         
 
          
          	[bookmark: pgfId-5177609]learn more about the contents of the columns that appear in the Health event view
  
          	[bookmark: pgfId-5177613]find more information in Understanding the Health Events Table.
  
         
 
          
          	[bookmark: pgfId-5177616]modify the time and date range for events listed in the Health table view
  
          	[bookmark: pgfId-5177620]find more information in Setting Event Time Constraints.
 [bookmark: pgfId-5177622]Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.
  
         
 
          
          	[bookmark: pgfId-5177624]sort the events that appear, change what columns display in the table of events, or constrain the events that appear
  
          	[bookmark: pgfId-5177628]find more information in Sorting Drill-Down Workflow Pages.
  
         
 
          
          	[bookmark: pgfId-5177631]delete health events
  
          	[bookmark: pgfId-5177633]select the check box next to the events you want to delete and click Delete. To delete all the events in the current constrained view, click Delete All, then confirm you want to delete all the events.
  
         
 
          
          	[bookmark: pgfId-5177635]navigate through event view pages
  
          	[bookmark: pgfId-5177639]find more information in Navigating to Other Pages in the Workflow.
  
         
 
          
          	[bookmark: pgfId-5177642]navigate to other event tables to view associated events
  
          	[bookmark: pgfId-5177646]find more information in Navigating Between Workflows.
  
         
 
          
          	[bookmark: pgfId-5177649]bookmark the current page so that you can quickly return to it
  
          	[bookmark: pgfId-5177651]click Bookmark This Page, provide a name for the bookmark and click Save. See Using Bookmarks for more information.
  
         
 
          
          	[bookmark: pgfId-5177656]navigate to the bookmark management page
  
          	[bookmark: pgfId-5177658]click View Bookmarks from any event view. See Using Bookmarks for more information.
  
         
 
          
          	[bookmark: pgfId-5177663]generate a report based on data in the table view
  
          	[bookmark: pgfId-5177667]click Report Designer. See Creating a Report Template from an Event View for more information.
  
         
 
          
          	[bookmark: pgfId-5177670]select another health events workflow
  
          	[bookmark: pgfId-5177672]click (switch workflow). See Selecting Workflows for more information.
  
         
 
          
          	[bookmark: pgfId-5177677]view the details associated with a single health event
  
          	[bookmark: pgfId-5177679]click the down arrow link on the left side of the event.
  
         
 
          
          	[bookmark: pgfId-5177681]view event details for multiple health events
  
          	[bookmark: pgfId-5177683]select the check box next to the rows that correspond with the events you want to view details for and then click View.
  
         
 
          
          	[bookmark: pgfId-5177685]view event details for all events in the view
  
          	[bookmark: pgfId-5177687]click View All.
  
         
 
          
          	[bookmark: pgfId-5177689]view all events of a particular status
  
          	[bookmark: pgfId-5177691]click the status icon in the Status column for an event with that status. 
  
         
 
         
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-5483462][bookmark: 69167]Interpreting Hardware Al[bookmark: marker-5483460]ert Det[bookmark: marker-5483461]ails for 3D9900 Devices
 
     [bookmark: pgfId-5613363]License: Any
 
     [bookmark: pgfId-5483463]For 3D9900 device models, hardware alarms generate in response to the events described in the following table. The triggering condition can be found in the message detail for the alert.
 
      
       [bookmark: pgfId-5483525]
 
       
        
         
         [bookmark: pgfId-5483473]Table 68-9 [bookmark: 26770]Conditions Monitored for 3D9900 Devices 
 
         
         
          
          	 
            
            [bookmark: pgfId-5483477]Condition Monitored 
           
  
          	 
            
            [bookmark: pgfId-5483479]Causes of Yellow or Red Error Conditions 
           
  
         
 
          
          	[bookmark: pgfId-5483481]NFE card presence
  
          	[bookmark: pgfId-5483483]If NFE hardware is detected that is not valid for the appliance, health status for the Hardware Alarms module changes to red and the message details include a reference to the NFE card presence. 
  
         
 
          
          	[bookmark: pgfId-5483485]NFE temperature
  
          	[bookmark: pgfId-5483487]If NFE temperature exceeds 95 degrees Celsius, health status for the Hardware Alarms module changes to yellow and the message details include a reference to the NFE temperature. 
 [bookmark: pgfId-5483488]If NFE temperature exceeds 99 degrees Celsius, health status for the Hardware Alarms module changes to red and the message details include a reference to the NFE temperature.
  
         
 
          
          	[bookmark: pgfId-5483490]NFE Platform daemon
  
          	[bookmark: pgfId-5483492]If the NFE Platform daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon. 
  
         
 
          
          	[bookmark: pgfId-5483494]NFE Message daemon
  
          	[bookmark: pgfId-5483496]If the NFE Message daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon. 
  
         
 
          
          	[bookmark: pgfId-5483498]NFE TCAM daemon
  
          	[bookmark: pgfId-5483500]If the NFE TCAM daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon. 
  
         
 
          
          	[bookmark: pgfId-5483502]LBIM presence
  
          	[bookmark: pgfId-5483504]If the Load Balancing Interface Module (LBIM) switch assembly is not present or not communicating, health status for the Hardware Alarms module changes to red and the message details include a reference to the LBIM presence.
  
         
 
          
          	[bookmark: pgfId-5483506]Scmd daemon
  
          	[bookmark: pgfId-5483508]If the Scmd daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon. 
  
         
 
          
          	[bookmark: pgfId-5483510]Psls daemon
  
          	[bookmark: pgfId-5483512]If the Psls daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon. 
  
         
 
          
          	[bookmark: pgfId-5483514]Ftwo daemon
  
          	[bookmark: pgfId-5483516]If the Ftwo daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon. 
  
         
 
          
          	[bookmark: pgfId-5483518]Rulesd (host rules) daemon
  
          	[bookmark: pgfId-5483520]If the Rulesd daemon goes down, health status for the Hardware Alarms module changes to yellow and the message details include a reference to the daemon. 
  
         
 
          
          	[bookmark: pgfId-5483522]nfm_ipfragd (host frag) daemon
  
          	[bookmark: pgfId-5483524]If the nfm_ipfragd daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon. 
  
         
 
         
       
 
      
 
     
 
    
 
     
      [bookmark: pgfId-5553974][bookmark: 36803]Interpreting Hardware Alert Details for Series 3 Devices
 
      
      [bookmark: pgfId-5484280]Condition Monitored 
     
 
      
      [bookmark: pgfId-5484282]Causes of Yellow or Red Error Conditions 
     
 
     [bookmark: pgfId-5523460]Cluster status
 
     [bookmark: pgfId-5523462]If clustered devices are no longer communicating with each other (due, for example, to a cabling problem), the Hardware Alarms module changes to red.
 
     [bookmark: pgfId-5484284]ftwo daemon status
 
     [bookmark: pgfId-5484286]If the ftwo daemon goes down, health status for the Hardware Alarms module changes to red and message details include a reference to the daemon.
 
     [bookmark: pgfId-5484288]NFE cards detected
 
     [bookmark: pgfId-5484290]Indicates the number of NFE cards detected on the system. If this value does not match the appliance’s expected NFE count, the Hardware Alarms module changes to red.
 
     [bookmark: pgfId-5484292]NFE hardware status
 
     [bookmark: pgfId-5484294]If one or more NFE cards are not communicating, the Hardware Alarms module changes to red and the applicable card appears in the message details.
 
     [bookmark: pgfId-5484296]NFE heartbeat
 
     [bookmark: pgfId-5484298]If the system detects no NFE heartbeat, the Hardware Alarms module changes to red and message details include a reference to the relevant card(s).
 
     [bookmark: pgfId-5484300]NFE internal link status
 
     [bookmark: pgfId-5484302]If the link between the NMSB and NFE card(s) goes down, the Hardware Alarms module changes to red and message details include a reference to the relevant ports.
 
     [bookmark: pgfId-5484304]NFE Message daemon
 
     [bookmark: pgfId-5484306]If the NFE Message daemon goes down, health status for the Hardware Alarms module changes to red and the message details include a reference to the daemon (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5484308]NFE temperature
 
     [bookmark: pgfId-5484310]If NFE temperature exceeds 97 degrees Celsius, health status for the Hardware Alarms module changes to yellow and message details include a reference to the NFE temperature (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5485958]If NFE temperature exceeds 102 degrees Celsius, health status for the Hardware Alarms module changes to red and message details include a reference to the NFE temperature. (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5484312]NFE temperature status
 
     [bookmark: pgfId-5484314]Indicates the current temperature status of the given NFE card. The Hardware Alarms module indicates green for OK, yellow for Warning, and red for Critical (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5484316]NFE TCAM daemon
 
     [bookmark: pgfId-5484318]If the NFE TCAM daemon goes down, health status for the Hardware Alarms module changes to red and message details include a reference to the daemon (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5484320]nfm_ipfragd (host frag) daemon
 
     [bookmark: pgfId-5484322]If the nfm_ipfragd daemon goes down, health status for the Hardware Alarms module changes to red and message details include a reference to the daemon (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5484324]NFE Platform daemon
 
     [bookmark: pgfId-5484326]If the NFE Platform daemon goes down, health status for the Hardware Alarms module changes to red and message details include a reference to the daemon (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5484328]NMSB communications
 
     [bookmark: pgfId-5484330]If the Media assembly is not present or not communicating, health status for the Hardware Alarms module changes to red and message details include a reference to the NFE temperature (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5484332]psls daemon status
 
     [bookmark: pgfId-5484334]If the psls daemon goes down, health status for the Hardware Alarms module changes to red and message details include a reference to the daemon.
 
     [bookmark: pgfId-5484336]Rulesd (host rules) daemon
 
     [bookmark: pgfId-5484338]If the Rulesd daemon goes down, health status for the Hardware Alarms module changes to yellow and message details include a reference to the daemon (and, if applicable, the NFE card number).
 
     [bookmark: pgfId-5484340]scmd daemon status
 
     [bookmark: pgfId-5487258]If the scmd daemon goes down, health status for the Hardware Alarms module changes to red and message details include a reference to the daemon. 
 
    
 
   
 
    
     [bookmark: pgfId-5483836][bookmark: 16018]Understanding the Health Ev[bookmark: marker-5177761]ents Table
 
    [bookmark: pgfId-5613382]License: Any
 
    [bookmark: pgfId-5177766]You can use the Defense Center’s health monitor to determine the status of critical functionality within the FireSIGHT System. You create and apply health policies to your appliances, which monitor a variety of aspects, including hardware and software status. The Health Monitor modules you choose to enable in your health policy run various tests to determine appliance health status. When the health status meets criteria that you specify, a health event is generated. For more information on health monitoring, see Monitoring the System.
 
    [bookmark: pgfId-5177776]The fields in the health events table are[bookmark: marker-5177773] described in the following table.
 
     
      [bookmark: pgfId-5177834]
 
      
       
        
        [bookmark: pgfId-5177784]Table 68-11 [bookmark: 79641]Health Event Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-5177788]Field 
          
  
         	 
           
           [bookmark: pgfId-5177790]Description 
          
  
        
 
         
         	[bookmark: pgfId-5177799]Test Name
  
         	[bookmark: pgfId-5239684]The name of the health module that generated the event. For a list of health modules, see the Health Modules table.
  
        
 
         
         	[bookmark: pgfId-5177803]Time
  
         	[bookmark: pgfId-5177805]The timestamp for the health event.
  
        
 
         
         	[bookmark: pgfId-5177807]Description
  
         	[bookmark: pgfId-5177809]The description of the health module that generated the event. For example, health events generated when a process was unable to execute are labeled Unable to Execute.
  
        
 
         
         	[bookmark: pgfId-5177811]Value
  
         	[bookmark: pgfId-5177813]The value (number of units) of the result obtained by the health test that generated the event.
 [bookmark: pgfId-5177817]For example, if the Defense Center generates a health event whenever a device it is monitoring is using 80 percent or more of its CPU resources, the value could be a number from 80 to 100.
  
        
 
         
         	[bookmark: pgfId-5177819]Units
  
         	[bookmark: pgfId-5177821]The units descriptor for the result. You can use the asterisk (*) to create wildcard searches. 
 [bookmark: pgfId-5177825]For example, if the Defense Center generates a health event when a device it is monitoring is using 80 percent or more of its CPU resources, the units descriptor is a percentage sign (%).
  
        
 
         
         	[bookmark: pgfId-5177827]Status
  
         	[bookmark: pgfId-5177829]The status (Critical, Yellow, Green, or Disabled) reported for the appliance. 
  
        
 
         
         	[bookmark: pgfId-5177831]Device
  
         	[bookmark: pgfId-5177833]The appliance where the health event was reported.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-5177835]To display the table view of health events:
 
     [bookmark: pgfId-5177836]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177837]Step 1 Select Health > Health Events.
 
     [bookmark: pgfId-5177840]The table view appears. For information on working with health events, see Working with Health Events.
 
      
       
     
 
     
 
     [bookmark: pgfId-5177844]Tip If you are using a custom workflow that does not include the table view of health events, click (switch workflow). On the Select Workflow page, click Health Events.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5613401]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-5177848][bookmark: 27385]Searching for Healt[bookmark: marker-5177847]h Events
 
    [bookmark: pgfId-5613421]License: Any
 
    [bookmark: pgfId-5177858]You can search for specific health events. You may want to create searches customized for your network environment, then save them to reuse later. The following table describes the search criteria you can use.
 
     
      [bookmark: pgfId-5177902]
 
      
       
        
        [bookmark: pgfId-5596108]Table 68-12 [bookmark: 22686]Health Event Search Criteria
 
        
        
         
         	 
           
           [bookmark: pgfId-5177872]Search Field 
          
  
         	 
           
           [bookmark: pgfId-5177874]Description 
          
  
        
 
         
         	[bookmark: pgfId-5177876]Module Name
  
         	[bookmark: pgfId-5177878]Specify the name of the module which generated the health events you want to view. For example, to view events that measure CPU performance, type CPU. The search should retrieve applicable CPU Usage and CPU temperature events.
  
        
 
         
         	[bookmark: pgfId-5177880]Value
  
         	[bookmark: pgfId-5177882]Specify the value (number of units) of the result obtained by the health test for the events you want to view. 
 [bookmark: pgfId-5177883]For example, if you specify a value of 15 and type CPU in the Units field, you retrieve events where the appliance CPU was running at 15% utilization at the time the test ran.
  
        
 
         
         	[bookmark: pgfId-5177885]Description
  
         	[bookmark: pgfId-5177887]Specify the description of the events you want to view. For example, you could enter Unable to Execute to view any health events where a process was unable to execute. You can use an asterisk (*) in this field to create wildcard searches. 
  
        
 
         
         	[bookmark: pgfId-5177889]Units
  
         	[bookmark: pgfId-5177891]Specify the units descriptor for the result obtained by the health test for the events you want to view. You can use an asterisk (*) in this field to create wildcard searches. 
 [bookmark: pgfId-5177892]For example, if you type % in the Units field, you retrieve all events for the Disk Usage modules, because the Disk Usage module has a “%” label in the Units field (and no additional text). However, if you type *% in the Units field, you retrieve all events for any modules that contain text followed by a “%” sign in the Units field.
  
        
 
         
         	[bookmark: pgfId-5177894]Status
  
         	[bookmark: pgfId-5177896]Specify the status for the health events that you want to view. Valid status levels are Critical, Warning, Normal, Error, and Disabled. 
 [bookmark: pgfId-5177897]For example, type Critical to retrieve all health events that indicate a critical status.
  
        
 
         
         	[bookmark: pgfId-5177899]Device
  
         	[bookmark: pgfId-5177901]Type the device name or IP address, or a device group, stack, or cluster name to restrict the search to health events generated by one or more specific devices. For detailed information on how the FireSIGHT System treats the device field in searches, see Specifying Devices in Searches.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-5312441]For more information on searching, including information on special search syntax as well as saving and loading searches, see Performing and Saving Searches.
 
     [bookmark: pgfId-5312442]To search for health events:
 
     [bookmark: pgfId-5177904]Access: Admin/Maint/Any Security Analyst
 
     
 
     [bookmark: pgfId-5177905]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-5177906]The Search page appears.
 
     [bookmark: pgfId-5239752]Step 2 Select Health Events from the table drop-down list.
 
     [bookmark: pgfId-5280613]The page updates with the appropriate constraints.
 
     [bookmark: pgfId-5177913]Step 3 Enter your search criteria in the appropriate fields, as described in the Health Event Search Criteria table.
 
     [bookmark: pgfId-5284377]If you enter multiple criteria, the search returns only the records that match all the criteria.
 
     [bookmark: pgfId-5177918]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-5177919]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-5177920]Step 5 Optionally, you can save the search to be used again in the future. You have to following options:
 
      
       
       	 [bookmark: pgfId-5686526]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-5686579]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so you can run it at a later time. 
 
      
       
       	 [bookmark: pgfId-5686910]Click  Save as New to save a new search or assign a name to a search you created by altering a previously-save search.
 
      
 
     
 
     [bookmark: pgfId-5687133]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-5686426]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-5177922]Your search results appear in the default health events workflow, constrained by the current time range. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-5613436]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-5177937]
 
     [bookmark: pgfId-2327985]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2574295]Audit[bookmark: 11549]i[bookmark: marker-2574294]ng the System 
      
      
 
     
 
 
    [bookmark: pgfId-1796237]You can audit activity on your system in two ways. The appliances that are part of the FireSIGHT System generate an audit record for each user interaction with the web interface, and also record system status messages in the system log.
 
    [bookmark: pgfId-2533292]The following sections provide more information about the monitoring features that the system provides:
 
     
     	 [bookmark: pgfId-2533296]Managing Audit Records describes how to view and manage system audit information.
 
     	 [bookmark: pgfId-2533300]Viewing the System Log describes how to view the system log, which contains system status messages.
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2533310]Tip Defense Centers and managed devices with Protection licenses also provide full reporting features that allow you to generate reports for almost any type of data accessible in an event view, including auditing data. For more information, see Working with Reports.
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1049923][bookmark: 24352]Managing Audit Records[bookmark: marker-1063297]
 
    [bookmark: pgfId-2533333]License: Any
 
    [bookmark: pgfId-2344585]Defense Centers and managed devices log read-only auditing information for user activity. Audit logs are presented in a standard event view that allows you to view, sort, and filter audit log messages based on any item in the audit view. You can easily delete and report on audit information and can view detailed reports of the changes that users make. 
 
    [bookmark: pgfId-1328496]The audit log stores a maximum of 100,000 entries. When the number of audit log entries exceeds 100,000, the appliance prunes the oldest records from the database to reduce the number to 100,000.
 
     
      
    
 
    
 
    [bookmark: pgfId-2533344]Note If you reboot a Series 3 appliance, then log into the CLI as soon as you are able, any commands you execute are not recorded in the audit log until the web interface is available.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1971042]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-1971063]Viewing Audit Records
 
     	 [bookmark: pgfId-2394271]Suppressing Audit Records
 
     	 [bookmark: pgfId-2316814]Understanding the Audit Log Table
 
     	 [bookmark: pgfId-2533352]Using the Audit Log to Examine Changes
 
     	 [bookmark: pgfId-1971153]Searching Audit Records
 
    
 
     
      [bookmark: pgfId-1970865][bookmark: 86046]Viewing Audit Records[bookmark: marker-1970864]
 
     [bookmark: pgfId-2533367]License: Any
 
     [bookmark: pgfId-2533374]You can use the appliance to view a table of audit records. Then, you can manipulate the view depending on the information you are looking for. The predefined audit workflow includes a single table view of events. You can also create a custom workflow that displays only the information that matches your specific needs. For information on creating a custom workflow, see Creating Custom Workflows.
 
     [bookmark: pgfId-2533426]The following table describes some of the specific actions you can perform on an audit log workflow page.
 
     [bookmark: pgfId-2533543]
 
      
      Using the Audit Log to Examine Changes 
      
 
       
        
        [bookmark: pgfId-2533433]Table 69-1 [bookmark: 90117]Audit Log Actions 
 
        
        
         
         	 
           
           [bookmark: pgfId-2533437]To... 
          
  
         	 
           
           [bookmark: pgfId-2533439]You can... 
          
  
        
 
         
         	[bookmark: pgfId-2533441]learn more about the contents of the columns in the table
  
         	[bookmark: pgfId-2533445]find more information in Understanding the Audit Log Table.
  
        
 
         
         	[bookmark: pgfId-2533448]modify the time range used when viewing audit records
  
         	[bookmark: pgfId-2533452]find more information at Setting Event Time Constraints.
 [bookmark: pgfId-2533454]Note that events that were generated outside the appliance's configured time window (whether global or event-specific) may appear in an event view if you constrain the event view by time. This may occur even if you configured a sliding time window for the appliance.
  
        
 
         
         	[bookmark: pgfId-2533456]sort and constrain events on the current workflow page
  
         	[bookmark: pgfId-2533460]find more information in Sorting Table View Pages and Changing Their Layout.
  
        
 
         
         	[bookmark: pgfId-2533463]navigate within the current workflow page
  
         	[bookmark: pgfId-2533467]find more information in Navigating to Other Pages in the Workflow.
  
        
 
         
         	[bookmark: pgfId-2533470]navigate between pages in the current workflow, keeping the current constraints
  
         	[bookmark: pgfId-2533472]click the appropriate page link at the top left of the workflow page. For more information, see Using Workflow Pages.
  
        
 
         
         	[bookmark: pgfId-2533477]drill down to the next page in the workflow
  
         	[bookmark: pgfId-2533479]use one of the following methods:
 
           
           	 [bookmark: pgfId-2533480]To drill down to the next workflow page constraining on a specific value, click  a value within a row. Note that this only works on drill-down pages. Clicking a value within a row in a table view constrains the table view and does  not drill down to the next page.
 
           	 [bookmark: pgfId-2533481]To drill down to the next workflow page constraining on some events, select the check boxes next to the events you want to view on the next workflow page, then click  View .
 
           	 [bookmark: pgfId-2533482]To drill down to the next workflow page keeping the current constraints, click  View All .
 
          
 [bookmark: pgfId-2533483]Tip Table views always include “Table View” in the page name. [bookmark: pgfId-2533486]For more information, see Constraining Events.
  
        
 
         
         	[bookmark: pgfId-2533489]constraining on a specific value
  
         	[bookmark: pgfId-2533491]Click a value within a row. 
 [bookmark: pgfId-2533492]If you click a value on a drill-down page, you move to the next page and constrain on the value.
 [bookmark: pgfId-2533493]Note that clicking a value within a row in a table view constrains the table view and does not drill down to the next page. 
 [bookmark: pgfId-2533494]Tip Table views always include “Table View“ in the page name. [bookmark: pgfId-2533497]For more information, see Constraining Events.
  
        
 
         
         	[bookmark: pgfId-2533500]delete audit records
  
         	[bookmark: pgfId-2533502]use one of the following methods:
 
           
           	 [bookmark: pgfId-2533503]To delete some items, select the check boxes next to events you want to delete, then click  Delete .
 
           	 [bookmark: pgfId-2533504]To delete all items in the current constrained view, click  Delete All , then confirm you want to delete all the events.
 
          
  
        
 
         
         	[bookmark: pgfId-2533506]temporarily use a different workflow
  
         	[bookmark: pgfId-2533508]click (switch workflow). For more information, see Selecting Workflows.
  
        
 
         
         	[bookmark: pgfId-2533513]bookmark the current page so you can quickly return to it
  
         	[bookmark: pgfId-2533515]click Bookmark This Page. For more information, see Using Bookmarks.
  
        
 
         
         	[bookmark: pgfId-2533520]navigate to the bookmark management page
  
         	[bookmark: pgfId-2533522]click View Bookmarks. For more information, see Using Bookmarks.
  
        
 
         
         	[bookmark: pgfId-2533527]generate a report based on the data in the current view
  
         	[bookmark: pgfId-2533529]click Report Designer. For more information, see Creating a Report Template from an Event View.
  
        
 
         
         	[bookmark: pgfId-2533534]view a summary of a change recorded in the audit log
  column. For more information, see . 
        
 
        
      
 
     
 
     [bookmark: pgfId-2293860]To view audit records:
 
     [bookmark: pgfId-2345891]Access: Admin
 
     
 
     [bookmark: pgfId-2533548]Step 1 Select System > Monitoring > Audit.
 
     [bookmark: pgfId-2554653]The first (and only) page of the default audit log workflow appears. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. If no events appear, you may need to adjust the time range. For more information, see Setting Event Time Constraints.
 
      
       
     
 
     
 
     [bookmark: pgfId-2533560]Tip If you are using a custom workflow that does not include the table view of audit events, click (switch workflow), then select Audit Log.
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2533562]Working with [bookmark: WorkingAuditEvents]Audit Events
 
     [bookmark: pgfId-2533573]License: Any
 . When you disable a column, it is disabled for the duration of your session (unless you add it back later). Note that when you disable the first column, the Count column is added. 
     
 
     [bookmark: pgfId-2533588]To hide or show other columns, or to add a disabled column back to the view, select or clear the appropriate check boxes before you click Apply. 
 
     [bookmark: pgfId-2533592]Clicking a value within a row in a table view constrains the table view and does not drill down to the next page. 
 
      
       
     
 
     
 
     [bookmark: pgfId-2533593]Tip Table views always include “Table View” in the page name.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2533594]For more information, see the following topics:
 
      
      	 [bookmark: pgfId-2533598]Constraining Events.
 
      	 [bookmark: pgfId-2533602]Using Compound Constraints
 
      	 [bookmark: pgfId-2533606]Sorting Drill-Down Workflow Pages
 
      	 [bookmark: pgfId-2533610]Understanding the Audit Log Table
 
     
 
    
 
     
      [bookmark: pgfId-2393943][bookmark: 87444]Suppressing Audit Records
 
     [bookmark: pgfId-2533625]License: Any
 
     [bookmark: pgfId-2393944]If your auditing policy does not require that you audit specific types of user interactions with the FireSIGHT System, you can prevent those interactions from generating audit records. For example, by default, each time a user views the online help, the FireSIGHT System generates an audit record. If you do not need to keep a record of these interactions, you can automatically suppress them.
 
     [bookmark: pgfId-2393945]To configure audit event suppression, you must have access to an appliance’s admin user account, and you must be able to either access the appliance’s console or open a secure shell. 
 
      
       
     
 
     
 
      
      [bookmark: pgfId-2393946] 
      Caution Make sure that only authorized personnel have access to the appliance and to its 
      admin account. 
       
       
 
      
 
     
 
     [bookmark: pgfId-2393947]To suppress audit records, you must create one or more files in the /etc/sf directory in the following form:
 
      
      [bookmark: pgfId-2393948]AuditBlock.type 
     
 
     [bookmark: pgfId-2393949]where type is address, message, subsystem, or user.
 
      
       
     
 
     
 
     [bookmark: pgfId-2393950]Note If you create an AuditBlock.type file for a specific type of audit message, but later decide that you no longer want to suppress them, you must delete the contents of the AuditBlock.type file but leave the file itself on the FireSIGHT System.
 
      
      
 
     
 
     
 
      
       
        
        [bookmark: pgfId-2393961]Table 69-2 [bookmark: 96129]Audit Block Types 
 
        
        
         
         	 
           
           [bookmark: pgfId-2393965]Type 
          
  
         	 
           
           [bookmark: pgfId-2393967]Description 
          
  
        
 
         
         	[bookmark: pgfId-2393969]Address
  
         	[bookmark: pgfId-2393971]Create a file named AuditBlock.address and include, one per line, each IP address that you want to suppress from the audit log. You can use partial IP addresses provided that they map from the beginning of the address. For example, the partial address 10.1.1 matches addresses from 10.1.1.0 through 10.1.1.255.
  
        
 
         
         	[bookmark: pgfId-2393973]Message
  
         	[bookmark: pgfId-2393975]Create a file named AuditBlock.message and include, one per line, the message substrings that you want to suppress. 
 [bookmark: pgfId-2393976]Note that substrings are matched so that if you include backup in your file, all messages that include the word backup are suppressed.
  
        
 
         
         	[bookmark: pgfId-2393978]Subsystem
  
         	[bookmark: pgfId-2393980]Create a file named AuditBlock.subsystem and include, one per line, each subsystem that you want to suppress. 
 [bookmark: pgfId-2393981]Note that substrings are not matched. You must use exact strings. See the Subsystem Names table for a list of subsystems that are audited.
  
        
 
         
         	[bookmark: pgfId-2393986]User
  
         	[bookmark: pgfId-2393988]Create a file named AuditBlock.user and include, one per line, each user account that you want to suppress. You can use partial string matching provided that they map from the beginning of the username. For example, the partial username IPSAnalyst matches the user names IPSAnalyst1 and IPSAnalyst2.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2529644]Note that when you add an AuditBlock file, an audit record with a subsystem of Audit and a message of Audit Filter type Changed is added to the audit events. For security reasons, this audit record cannot be suppressed.
 
      
       
        
        [bookmark: pgfId-2396476]Table 69-3 [bookmark: 32598]Subsystem Names 
 
        
        
         
         	 
           
           [bookmark: pgfId-2396480]Name 
          
  
         	 
           
           [bookmark: pgfId-2396482]Includes user interactions with... 
          
  
        
 
         
         	[bookmark: pgfId-2396484]Admin
  
         	[bookmark: pgfId-2396486]Administrative features such as system and access configuration, time synchronization, backup and restore, device management, user account management, and scheduling
  
        
 
         
         	[bookmark: pgfId-2396488]Alerting
  
         	[bookmark: pgfId-2396490]Alerting functions such as email, SNMP, and syslog alerting
  
        
 
         
         	[bookmark: pgfId-2396496]Audit Log
  
         	[bookmark: pgfId-2396498]Audit event views
  
        
 
         
         	[bookmark: pgfId-2396500]Audit Log Search
  
         	[bookmark: pgfId-2396502]Audit event searches
  
        
 
         
         	[bookmark: pgfId-2548519]Command Line
  
         	[bookmark: pgfId-2548521]Command line interface
  
        
 
         
         	[bookmark: pgfId-2396512]Configuration
  
         	[bookmark: pgfId-2396514]Email alerting
  
        
 
         
         	[bookmark: pgfId-2396516]COOP
  
         	[bookmark: pgfId-2396518]Continuity of operations feature
  
        
 
         
         	[bookmark: pgfId-2396520]Date
  
         	[bookmark: pgfId-2396522]Date and time range for event views
  
        
 
         
         	[bookmark: pgfId-2396524]Default Subsystem
  
         	[bookmark: pgfId-2396526]Options that do not have assigned subsystems
  
        
 
         
         	[bookmark: pgfId-2396528]Detection & Prevention Policy
  
         	[bookmark: pgfId-2396530]Menu options for intrusion policies
  
        
 
         
         	[bookmark: pgfId-2396532]Error
  
         	[bookmark: pgfId-2396534]System-level errors
  
        
 
         
         	[bookmark: pgfId-2396536]eStreamer
  
         	[bookmark: pgfId-2396538]eStreamer configuration
  
        
 
         
         	[bookmark: pgfId-2396540]EULA
  
         	[bookmark: pgfId-2396542]Reviewing the end user license agreement
  
        
 
         
         	[bookmark: pgfId-2396544]Events
  
         	[bookmark: pgfId-2396549]Intrusion and discovery event views
  
        
 
         
         	[bookmark: pgfId-2396551]Events Clipboard
  
         	[bookmark: pgfId-2396553]Intrusion event clipboard
  
        
 
         
         	[bookmark: pgfId-2396555]Events Reviewed
  
         	[bookmark: pgfId-2396557]Reviewed intrusion events
  
        
 
         
         	[bookmark: pgfId-2396559]Events Search
  
         	[bookmark: pgfId-2396561]Any event search
  
        
 
         
         	[bookmark: pgfId-2396563]Failed to install rule update rule_update_id
  
         	[bookmark: pgfId-2396565]Installing rule updates
  
        
 
         
         	[bookmark: pgfId-2396571]Header
  
         	[bookmark: pgfId-2396573]Initial presentation of the user interface after a user logs in
  
        
 
         
         	[bookmark: pgfId-2396575]Health
  
         	[bookmark: pgfId-2396577]Health monitoring
  
        
 
         
         	[bookmark: pgfId-2396579]Health Events
  
         	[bookmark: pgfId-2396581]Health monitoring event views
  
        
 
         
         	[bookmark: pgfId-2396583]Help
  
         	[bookmark: pgfId-2396585]Online help
  
        
 
         
         	[bookmark: pgfId-2538194]High Availability
  
         	[bookmark: pgfId-2538196]High availability feature
  
        
 
         
         	[bookmark: pgfId-2396599]IDS Impact Flag
  
         	[bookmark: pgfId-2396601]Impact flag configuration
  
        
 
         
         	[bookmark: pgfId-2396603]IDS Policy
  
         	[bookmark: pgfId-2396605]Intrusion policies
  
        
 
         
         	[bookmark: pgfId-2396607]IDSPolicy > policy_name > Appliance > det_engine_name
  
         	[bookmark: pgfId-2396609]Applying intrusion policies
  
        
 
         
         	[bookmark: pgfId-2396611]IDSRule sid:sig_id rev:rev_num
  
         	[bookmark: pgfId-2396614]Intrusion rules by SID
  
        
 
         
         	[bookmark: pgfId-2396616]Incidents
  
         	[bookmark: pgfId-2396618]Intrusion incidents
  
        
 
         
         	[bookmark: pgfId-2396747]Insert Policy Apply Job
  
         	[bookmark: pgfId-2396749]Applying policies
  
        
 
         
         	[bookmark: pgfId-2396779]Install
  
         	[bookmark: pgfId-2396781]Installing updates
  
        
 
         
         	[bookmark: pgfId-2396791]Intrusion Events
  
         	[bookmark: pgfId-2396793]Intrusion events
  
        
 
         
         	[bookmark: pgfId-2396620]Login
  
         	[bookmark: pgfId-2396622]Web interface login and logout functions
  
        
 
         
         	[bookmark: pgfId-2396636]Menu
  
         	[bookmark: pgfId-2396638]Any menu option
  
        
 
         
         	[bookmark: pgfId-2396887]Configuration export > config_type > config_name
  
         	[bookmark: pgfId-2396889]Importing configurations of a specific type and name
  
        
 
         
         	[bookmark: pgfId-2548570]Permission Escalation
  
         	[bookmark: pgfId-2548572]User role escalation
  
        
 
         
         	[bookmark: pgfId-2396640]Preferences
  
         	[bookmark: pgfId-2396642]User preferences, such as the time zone for a user account and individual event preferences
  
        
 
         
         	[bookmark: pgfId-2396644]Policy
  
         	[bookmark: pgfId-2396646]Any policy, including intrusion policies
  
        
 
         
         	[bookmark: pgfId-2397013]Register
  
         	[bookmark: pgfId-2397015]Registering devices on a Defense Center
  
        
 
         
         	[bookmark: pgfId-2397091]RemoteStorageDevice
  
         	[bookmark: pgfId-2397093]Configuring remote storage devices
  
        
 
         
         	[bookmark: pgfId-2396648]Reports
  
         	[bookmark: pgfId-2396650]Report listing and report designer features
  
        
 
         
         	[bookmark: pgfId-2396676]Rules
  
         	[bookmark: pgfId-2396678]Intrusion rules, including the rule editor and the rule importation process
  
        
 
         
         	[bookmark: pgfId-2397523]Rule Update Import Log
  
         	[bookmark: pgfId-2397525]Viewing the rule update import log
  
        
 
         
         	[bookmark: pgfId-2397554]Rule Update Install
  
         	[bookmark: pgfId-2397556]Installing rule updates
  
        
 
         
         	[bookmark: pgfId-2396680]Status
  
         	[bookmark: pgfId-2396682]Syslog, as well as host and performance statistics
  
        
 
         
         	[bookmark: pgfId-2396684]System
  
         	[bookmark: pgfId-2396686]Various system-wide settings
  
        
 
         
         	[bookmark: pgfId-2397606]System Policy > policy_name Appliance > appliance_name
  
         	[bookmark: pgfId-2397608]Applying system policies
  
        
 
         
         	[bookmark: pgfId-2396688]Task Queue
  
         	[bookmark: pgfId-2396690]Viewing the task queue
  
        
 
         
         	[bookmark: pgfId-2463560]Users
  
         	[bookmark: pgfId-2463562]Creating and modifying user accounts and roles
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2361255][bookmark: 35621]Understanding the[bookmark: marker-2361254] Audit Log Table
 
     [bookmark: pgfId-2533640]License: Any
 
      
       
        
        [bookmark: pgfId-2518886]Table 69-4 [bookmark: 69808]Audit Log Fields 
 
        
        
         
         	 
           
           [bookmark: pgfId-2518890]Field 
          
  
         	 
           
           [bookmark: pgfId-2518892]Description 
          
  
        
 
         
         	[bookmark: pgfId-2518894]Time
  
         	[bookmark: pgfId-2518896]Time and date that the appliance generated the audit record.
  
        
 
         
         	[bookmark: pgfId-2518898]User
  
         	[bookmark: pgfId-2518900]User name of the user that triggered the audit event.
  
        
 
         
         	[bookmark: pgfId-2518902]Subsystem
  
         	[bookmark: pgfId-2518904]Menu path the user followed to generate the audit record. For example, System > Monitoring > Audit is the menu path to view the audit log.
 [bookmark: pgfId-2541644]In a few cases where a menu path is not relevant, the Subsystem field displays only the event type. For example, Login classifies user login attempts.
  
        
 
         
         	[bookmark: pgfId-2518907]Message
  
         	[bookmark: pgfId-2518909]Action the user performed.
 [bookmark: pgfId-2518910]For example, Page View signifies that the user simply viewed the page indicated in the Subsystem, while Save means that the user clicked the Save button on the page.
 ) that you can click to see a summary of the changes. For more information, see Using the Audit Log to Examine Changes.
  
        
 
         
         	[bookmark: pgfId-2518916]Source IP
  
         	[bookmark: pgfId-2518918]IP address associated with the host used by the user.
  
        
 
         
         	[bookmark: pgfId-2518920]Count
  
         	[bookmark: pgfId-2518922]The number of events that match the information that appears in each row. Note that the Count field appears only after you apply a constraint that creates two or more identical rows.
  
        
 
        
      
 
     
 
    
 
     
      [bookmark: pgfId-2533647][bookmark: 96049]Using the Audit Log to Examine Changes
 
     [bookmark: pgfId-2533658]License: Any
 
     [bookmark: pgfId-2533659]You can use the audit log to view detailed reports of changes to your system. These reports compare the current configuration of your system to its most recent configuration before a particular change. 
 ) appears next to audit log events that reflect changes to the system. You can click the compare icon to access the Compare Configurations page and view a detailed report of a change. 
     
 
     [bookmark: pgfId-2533664]The Compare Configurations page displays the differences between the system configuration before changes and the running configuration in a side-by-side format. The audit event type, time of last modification, and name of the user who made the change are displayed in the title bar above each configuration.
 
     [bookmark: pgfId-2533665]Differences between the two configurations are highlighted: 
 
      
      	 [bookmark: pgfId-2533666]Blue indicates that the highlighted setting is different in the two configurations, and the difference is noted in red text.
 
      	 [bookmark: pgfId-2533667]Green indicates that the highlighted setting appears in one configuration but not the other.
 
     
 
     [bookmark: pgfId-2533668]To examine a change in the audit log:
 
     [bookmark: pgfId-2533669]Access: Admin
 
     
 
     [bookmark: pgfId-2533670]Step 1 Select System > Monitoring > Audit.
 
     [bookmark: pgfId-2533671]The first page of the default audit log workflow appears. 
 
     [bookmark: pgfId-2533672]If you are using a custom workflow that does not include the table view of audit events, click (switch workflow), then select Audit Log.
 column. 
     
 
     [bookmark: pgfId-2533677]The Compare Configurations page appears. Note that you can navigate through changes individually by clicking Previous or Next above the title bar. If the change summary is more than one page long, you can also use the scroll bar on the right to view additional changes.
 
     [bookmark: pgfId-2583509]
 
      
      
 
     
 
     
 
    
 
     
      [bookmark: pgfId-2520854][bookmark: 13007]Searching [bookmark: marker-2520851]Audit Reco[bookmark: AuditSearch]rds
 
     [bookmark: pgfId-2533697]License: Any
 
     [bookmark: pgfId-1948022]You can search audit records to find information specific to a user, a specific subsystem, or an audit record message. 
 
      
       
        
        [bookmark: pgfId-2300564]Table 69-5 [bookmark: 44997]Audit Record Search Criteria 
 
        
        
         
         	 
           
           [bookmark: pgfId-2300570]Search Field 
          
  
         	 
           
           [bookmark: pgfId-2300572]Description 
          
  
         	 
           
           [bookmark: pgfId-2300574]Example 
          
  
        
 
         
         	[bookmark: pgfId-2300576]User
  
         	[bookmark: pgfId-2300578]Enter the user name of the user who triggered the audit events you want to see. You can use an asterisk (*) as a wildcard character in this field.
  
         	[bookmark: pgfId-2300580]jsmith returns all audit records involving the user jsmith.
  
        
 
         
         	[bookmark: pgfId-2300582]Subsystem
  
         	[bookmark: pgfId-2300584]Enter the full menu path a user would follow to generate the audit records you want to see. You can use an asterisk (*) as a wildcard character in this field.
  
         	[bookmark: pgfId-2300586]System > Monitoring > Audit and *Audit both return audit records that involve using the audit log.
 [bookmark: pgfId-2300587]*Audit* returns all of the above records, plus records that involve searching for audit records.
  
        
 
         
         	[bookmark: pgfId-2300589]Message
  
         	[bookmark: pgfId-2300591]The action the user performed or the button the user clicked on the page. You can use an asterisk (*) as a wildcard character in this field.
  
         	[bookmark: pgfId-2326273]Apply returns audit records where the user applied an intrusion policy.
 [bookmark: pgfId-2533944]Save Rule returns audit records where the user saved a correlation rule.
 [bookmark: pgfId-2300595]Page View returns audit records where the user viewed the page.
  
        
 
         
         	[bookmark: pgfId-2300597]Time
  
         	[bookmark: pgfId-2300599]Specify the date and time the audit record was generated. See Specifying Time Constraints in Searches for the syntax for entering time.
  
         	[bookmark: pgfId-2300604]> 2006-01-15 13:30:00 returns all audit records generated after January 15, 2006 at 1:30 PM.
  
        
 
         
         	[bookmark: pgfId-2300606]Source IP
  
         	[bookmark: pgfId-2300608]Enter the IP address of the host that you want to view audit records for. 
 type a specific IP address. You cannot use IP ranges when searching audit logs.
  
         	[bookmark: pgfId-2300611]172.16.1.37 returns all audit records generated by a user from the 172.16.1.37 IP address.
  
        
 
         
         	[bookmark: pgfId-2521001]Configuration Change
  
         	[bookmark: pgfId-2521003]Specify whether or not you want to view audit records of configuration changes.
  
         	[bookmark: pgfId-2521005]yes returns audit records of configuration changes.
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2300613]For more information on searching, including how to load and delete saved searches, see Searching for Events.
 
     [bookmark: pgfId-2292656]To search for audit records:
 
     [bookmark: pgfId-2345910]Access: Admin
 
     
 
     [bookmark: pgfId-2540532]Step 1 Select Analysis > Search.
 
     [bookmark: pgfId-2540533]The Search page appears.
 
     [bookmark: pgfId-2540534]Step 2 Select Audit Log Events from the table drop-down list.
 
     [bookmark: pgfId-2292658]The Audit Log search page appears.
 
      
       
     
 
     
 
     [bookmark: pgfId-2292664]Tip To search the database for a different kind of event, select it from the table drop-down list.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2292668]Step 3 Enter your search criteria in the appropriate fields, as described in the Audit Record Search Criteria table. 
 
     [bookmark: pgfId-2539160]If you enter criteria for multiple fields, the search returns only the records that match search criteria specified for all fields.
 
     [bookmark: pgfId-2533717]Step 4 Optionally, if you plan to save the search, you can select the Private check box to save the search as private so only you can access it. Otherwise, leave the check box clear to save the search for all users.
 
      
       
     
 
     
 
     [bookmark: pgfId-2533718]Tip If you want to use the search as a data restriction for a custom user role, you must save it as a private search.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2292676]Step 5 Optionally, you can save the search to be used again in the future. You have the following options:
 
      
       
       	 [bookmark: pgfId-2590477]Click  Save to save the search criteria.
 
      
 
     
 
     [bookmark: pgfId-2590478]For a new search, a dialog box appears prompting for the name of the search; enter a unique search name and click Save. If you save new criteria for a previously-existing search, no prompt appears. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
      
       
       	 [bookmark: pgfId-2590479]Click  Save As New to save a new search or assign a name to a search you created by altering a previously-saved search.
 
      
 
     
 
     [bookmark: pgfId-2590480]A dialog box appears prompting for the name of the search; enter a unique search name and click Save. The search is saved (and visible only to your account if you selected Private) so that you can run it at a later time.
 
     [bookmark: pgfId-2292677]Step 6 Click Search to start the search.
 
     [bookmark: pgfId-2354488]Your search results appear in the default audit log workflow, constrained by the current time range. To use a different workflow, including a custom workflow, click (switch workflow). For information on specifying a different default workflow, see Configuring Event View Settings. 
 
     [bookmark: pgfId-2583521]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-2533744][bookmark: 50523]Viewing the System [bookmark: marker-2533743]Log
 
    [bookmark: pgfId-2533755]License: Any
 
    [bookmark: pgfId-2533757]The System Log (syslog) page provides you with system log information for the appliance. The system log displays each message generated by the system. The following items are listed in order:
 
     
     	 [bookmark: pgfId-2533758]the date that the message was generated
 
     	 [bookmark: pgfId-2533759]the time that the message was generated
 
     	 [bookmark: pgfId-2533760]the host that generated the message
 
     	 [bookmark: pgfId-2533761]the message itself
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-2533765]Note System log information is local. For example, you cannot use the Defense Center to view system status messages in the system logs on your managed devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2533766]You can view system log messages for specific components by using the filter feature. For more information, see Filtering System Log Messages.
 
    [bookmark: pgfId-2533770]To view the syslog:
 
    [bookmark: pgfId-2533771]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-2533772]Step 1 Select System > Monitoring > Syslog.
 
    [bookmark: pgfId-2533776]The System Log page appears.
 
     
      
    
 
    
 
    [bookmark: pgfId-2558665]Tip On the 3D9900, the Load Balancing Interface Module (LBIM) forwards messages to the device's syslog. You can find these messages by filtering on lbim.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2583534]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-2533784][bookmark: 90041]Filtering Syst[bookmark: marker-2533783]em Log Messages
 
     [bookmark: pgfId-2533795]License: Any
 
     [bookmark: pgfId-2533796]You can view system log messages for specific components by using the filter feature. Filtering allows you to search for specific messages based on content. 
 
     [bookmark: pgfId-2589995]The filter functionality uses the UNIX file search utility Grep, and as such, you can use most syntax accepted by Grep. This includes using Grep-compatible regular expressions for pattern matching. You can use a single word as a filter, or you can use Grep-supported regular expressions to search for content. 
 
     [bookmark: pgfId-2589996]The following table shows the regular expression syntax you can use in System Log filters:
 
     [bookmark: pgfId-2533880]
 
      
       
        
        [bookmark: pgfId-2533809]Table 69-6 [bookmark: 53200]System Log Filter Syntax 
 
        
        
         
         	 
           
           [bookmark: pgfId-2533815]Syntax Component 
          
  
         	 
           
           [bookmark: pgfId-2533817]Description 
          
  
         	 
           
           [bookmark: pgfId-2533819]Example 
          
  
        
 
         
         	[bookmark: pgfId-2533821].
  
         	[bookmark: pgfId-2533823]Matches any character or white space
  
         	[bookmark: pgfId-2533825]Admi. matches Admin, AdmiN, Admi1, and Admi&
  
        
 
         
         	[bookmark: pgfId-2533827][[:alpha:]]
  
         	[bookmark: pgfId-2533829]Matches any alphabetic character
  
         	[bookmark: pgfId-2533831][[:alpha:]]dmin matches Admin, bdmin, and Cdmin
  
        
 
         
         	[bookmark: pgfId-2533833][[:upper:]]
  
         	[bookmark: pgfId-2533835]Matches any uppercase alphabetic character
  
         	[bookmark: pgfId-2533837][[:upper:]]dmin matches Admin, Bdmin, and Cdmin
  
        
 
         
         	[bookmark: pgfId-2533839][[:lower:]]
  
         	[bookmark: pgfId-2533841]Matches any lowercase alphabetic character
  
         	[bookmark: pgfId-2533843][[:lower:]]dmin matches admin, bdmin, and cdmin
  
        
 
         
         	[bookmark: pgfId-2533845][[:digit:]]
  
         	[bookmark: pgfId-2533847]Matches any numeric character
  
         	[bookmark: pgfId-2533849][[:digit:]]dmin matches 0dmin, 1dmin, and 2dmin
  
        
 
         
         	[bookmark: pgfId-2533851][[:alnum:]]
  
         	[bookmark: pgfId-2533853]Matches any alphanumeric character
  
         	[bookmark: pgfId-2533855][[:alnum:]]dmin matches 1dmin, admin, 2dmin, and bdmin
  
        
 
         
         	[bookmark: pgfId-2533857][[:space:]]
  
         	[bookmark: pgfId-2533859]Matches any white space, including tabs
  
         	[bookmark: pgfId-2533861]Feb[[:space:]]29 matches logs from February 29th.
  
        
 
         
         	[bookmark: pgfId-2533863]*
  
         	[bookmark: pgfId-2533865]Matches zero or more instances of the character or expression it follows
  
         	[bookmark: pgfId-2533867]ab* matches a, ab, abb, ca, cab, and cabb
 [bookmark: pgfId-2568245][ab]* matches anything
  
        
 
         
         	[bookmark: pgfId-2533869]?
  
         	[bookmark: pgfId-2533871]Matches zero or one instances
  
         	[bookmark: pgfId-2533873]ab? matches a or ab.
  
        
 
         
         	[bookmark: pgfId-2533875]\
  
         	[bookmark: pgfId-2533877]Allows you to search for a character typically interpreted as regular expression syntax
  
         	[bookmark: pgfId-2533879]alert\? matches alert?.
  
        
 
        
      
 
     
 
      
       
        
        [bookmark: pgfId-2533892]Table 69-7 [bookmark: 97361]System Log Filter Examples 
 
        
        
         
         	 
           
           [bookmark: pgfId-2533896]To search for all log entries that... 
          
  
         	 
           
           [bookmark: pgfId-2533898]Use... 
          
  
        
 
         
         	[bookmark: pgfId-2533900]Are generated on November 5
  
         	[bookmark: pgfId-2533902]Nov[[:space:]]*5
  
        
 
         
         	[bookmark: pgfId-2533904]Contain the user name “Admin”
  
         	[bookmark: pgfId-2533906]Admin
  
        
 
         
         	[bookmark: pgfId-2533908]Contain authorization debugging information on November 5
  
         	[bookmark: pgfId-2533910]Nov[[:space:]]*5.*AUTH.*DEBUG
  
        
 
        
      
 
     
 
     [bookmark: pgfId-2533912]To search for specific message content in the system log:
 
     [bookmark: pgfId-2533913]Access: Admin/Maint
 
     
 
     [bookmark: pgfId-2533914]Step 1 Select System > Monitoring > Syslog.
 
     [bookmark: pgfId-2550260]The System Log page appears.
 
     [bookmark: pgfId-2550295]Step 2 Enter a word or query in the filter field. 
 
     [bookmark: pgfId-2533920]See the tables above for more information about the filter syntax you can use.
 
      
       
     
 
     
 
     [bookmark: pgfId-2533922]Note Only Grep-compatible search syntax is supported. For example, you could search for all NTP-related system log messages by using ntp as a filter, or search for all messages generated in November by using Nov as a filter. You could view messages from November 27th by using Nov[[:space:]]*27 or Nov.*27, but you could not, however, use Nov 27 or Nov*27 to view these messages.
 
      
      
 
     
 
     
 
     [bookmark: pgfId-2533923]Step 3 Optionally, to make your search case-sensitive, check Case-sensitive. (By default, filters are not case-sensitive.)
 
     [bookmark: pgfId-2533924]Step 4 Optionally, check Exclusion to search for all system log messages that do not meet the criteria you entered.
 
     [bookmark: pgfId-2533925]Step 5 Click Go.
 
     [bookmark: pgfId-2533926]The messages that match the filter appear.
 
     [bookmark: pgfId-2583550]
 
      
      
 
     
 
     
 
     [bookmark: pgfId-1865987]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1898576][bookmark: 22742][bookmark: 85440]Using Backup[bookmark: marker-6083429] and Restore 
      
      
 
     
 
 
    [bookmark: pgfId-7832727]Backup and restoration is an essential part of any system maintenance plan. While each organization’s backup plan is highly individualized, the FireSIGHT System provides a mechanism for archiving data so that data from a Defense Center or physical managed device can be restored in case of disaster. 
 
    [bookmark: pgfId-7819879]Note the following limitations about backup and restore:
 
     
     	 [bookmark: pgfId-7821195]Backups are valid only for the product version on which you create them.
 
     	 [bookmark: pgfId-7831675]Backups do not include captured file data.
 
     	 [bookmark: pgfId-7826138]You cannot create or restore backup files for virtual managed devices, Cisco NGIPS for Blue Coat X-Series, or Cisco ASA with FirePOWER Services. To back up all event data, perform a backup of the managing Defense Center.
 
     	 [bookmark: pgfId-7125268]You can restore a backup onto a replacement appliance only if the two appliances are the same model and are running the same version of the FireSIGHT System software. 
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7727342] 
     Caution Do not use the backup and restore process to copy the configuration files between managed devices. The configuration files include information that uniquely identifies a device and cannot be shared. 
      
      
 
     
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7779097] 
     Caution If you applied any intrusion rule updates, those updates are not backed up. You need to apply the latest rule update 
     after you restore. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7739546]You can save backup files to the appliance or to your local computer. Additionally, if you are using a Defense Center, you can use remote storage as detailed in Managing Remote Storage.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7793745] 
     Caution Never insert a USB drive into any USB port on a 3D9900. Additionally, remove any device with external storage (for example, a KVM switch with external storage) from a 3D9900 before upgrading or restoring the device. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7739588]See the following sections for more information:
 
     
     	 [bookmark: pgfId-7739531]See Creating Backup Files for information about creating backup files for Defense Centers and physical managed devices. 
 
     	 [bookmark: pgfId-7773204]See Creating Backup Profiles for information about creating backup profiles that you can use later as templates for creating backups. 
 
     	 [bookmark: pgfId-7259067]See Uploading Backups from a Local Host for information about uploading backup files from a local host.
 
     	 [bookmark: pgfId-1845557]See Restoring the Appliance from a Backup File for information about how to restore a backup file to the appliance.
 
    
 
   
 
    
     [bookmark: pgfId-1759507][bookmark: 69459]Creating Ba[bookmark: marker-1759506]ckup Files
 
    [bookmark: pgfId-7808470]License: Any
 
    [bookmark: pgfId-7822053]Supported Devices: Any except virtual, X-Series, and ASA FirePOWER
 
    [bookmark: pgfId-7822039]Supported Defense Centers: Any
 
    [bookmark: pgfId-7830124]You can perform backups of physical managed devices from the devices themselves, backups of physical managed devices from their managing Defense Center, and backups of Defense Centers. The system backs up different data depending on the type of backup you perform. Note that the system does not back up captured file data. Use the following table to determine what kind of backup you want to perform.
 
    [bookmark: pgfId-7830172]
 
     
      
       
       [bookmark: pgfId-7830127]Table 70-1 Data Stored by Backup Type
 
       
       
        
        	 
          
          [bookmark: pgfId-7830135]Backup type 
         
  
        	 
          
          [bookmark: pgfId-7830137]Includes configuration data? 
         
  
        	 
          
          [bookmark: pgfId-7830139]Includes event data? 
         
  
        	 
          
          [bookmark: pgfId-7830141]Includes unified files? 
         
  
       
 
        
        	[bookmark: pgfId-7830146]Defense Center
  
        	[bookmark: pgfId-7830148]Yes
  
        	[bookmark: pgfId-7830150]Yes
  
        	[bookmark: pgfId-7830152]No
  
       
 
        
        	[bookmark: pgfId-7830154]Physical managed device, performed from the device itself
  
        	[bookmark: pgfId-7830156]Yes
  
        	[bookmark: pgfId-7830158]No
  
        	[bookmark: pgfId-7830160]No
  
       
 
        
        	[bookmark: pgfId-7830162]Physical managed device, performed from the managing Defense Center
  
        	[bookmark: pgfId-7830167]Yes
  
        	[bookmark: pgfId-7830169]No
  
        	[bookmark: pgfId-7830171]Yes
  
       
 
       
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7808471]Note You cannot create or restore backup files for virtual managed devices, Cisco NGIPS for Blue Coat X-Series, or Cisco ASA with FirePOWER Services. To back up event data, perform a backup of the managing Defense Center.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7830876]To view and use existing system backups, go to the Backup Management page. You should periodically save a backup file that contains all of the configuration files required to restore the appliance, in addition to event data. You may also want to back up the system when testing configuration changes so that you can revert to a saved configuration if needed. You can choose to save the backup file on the appliance or on your local computer. 
 
    [bookmark: pgfId-7829438]You cannot create a backup file if your appliance does not have enough disk space; backups may fail if the backup process uses more than 90% of available disk space. If necessary, delete old backup files, transfer old backup files off the appliance, or use remote storage.
 
    [bookmark: pgfId-7734939]As an alternative, or if your backup file is larger than 4GB, copy it via SCP to a remote host. Uploading a backup from your local computer does not work on backup files larger than 4GB because web browsers do not support uploading files that large. On Defense Centers, the backup file can be saved to a remote location; see Managing Remote Storage for more information.
 
     
      
    
 
    
 
    [bookmark: pgfId-7773243]Note While your backup task is collecting discovery events, data correlation is temporarily suspended.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7815880]Note the following:
 
     
     	 [bookmark: pgfId-7815881]Private keys associated with PKI objects are encrypted with a randomly generated key when stored on the appliance. If you perform a backup that contains private keys associated with PKI objects, the private keys are decrypted before being included in the unencrypted backup file. Store the backup file in a secure location.
 
     	 [bookmark: pgfId-7818666]If you restore a backup that contains private key associated with PKI objects, the system encrypts the keys with a randomly generated key before storing them on the appliance.
 
     	 [bookmark: pgfId-7815882]If you perform a backup, then delete reviewed intrusion events, your backup restores the deleted intrusion events but does not restore their reviewed status. You view those restored intrusion events under Intrusion Events, not under Reviewed Events. See Reviewing Intrusion Events. 
 
     	 [bookmark: pgfId-7815886]If you restore a backup that contains intrusion event data on an appliance that already contains that data, duplicate events are created. To avoid this, restore intrusion event backups only on appliances without prior intrusion event data.
 
    
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7794682] 
     Caution If you configured any interface associations with security zones, these associations are not backed up. You must reconfigure them after you restore. For more information, see 
     Working with Security Zones. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7831122]To create a backup file of a Defense Center:
 
    [bookmark: pgfId-7831126]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-7831127]Step 1 Select System > Tools > Backup/Restore.
 
    [bookmark: pgfId-7831128]The Backup Management page appears.
 
    [bookmark: pgfId-7831132]Step 2 Click Defense Center Backup. 
 
    [bookmark: pgfId-7831133]The Create Backup page appears. 
 
    [bookmark: pgfId-7831134]Step 3 In the Name field, type a name for the backup file. You can use alphanumeric characters, punctuation, and spaces.
 
    [bookmark: pgfId-7831138]Step 4 On Defense Centers, you have two further options:
 
     
      
      	 [bookmark: pgfId-7831139]To archive the configuration, select  Back Up Configuration . 
 
      	 [bookmark: pgfId-7831140]To archive the entire event database, select  Back Up Events .
 
     
 
    
 
    [bookmark: pgfId-7831147]Step 5 Optionally, to be notified when the backup is complete, select the Email check box and type your email address in the accompanying text box.
 
     
      
    
 
    
 
    [bookmark: pgfId-7831150]Note To receive email notifications, you must configure a relay host as described in Configuring a Mail Relay Host and Notification Address.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7831155]Step 6 Optionally, on Defense Centers, to use secure copy (SCP) to copy the backup archive to a different machine, select the Copy when complete check box, then type the following information in the accompanying text boxes:
 
     
      
      	 [bookmark: pgfId-7831156]in the  Host field, the hostname or IP address of the machine where you want to copy the backup
 
      	 [bookmark: pgfId-7831157]in the  Path field, the path to the directory where you want to copy the backup
 
      	 [bookmark: pgfId-7831158]in the  User field, the user name you want to use to log into the remote machine
 
      	 [bookmark: pgfId-7831159]in the  Password field, the password for that user name
 If you prefer to access your remote machine with an SSH public key instead of a password, you must copy the contents of the  SSH Public Key field to the specified user’s  authorized_keys file on that machine.
 
     
 
    
 
    [bookmark: pgfId-7831160]With this option cleared, the system stores temporary files used during the backup on the remote server; temporary files are not stored on the remote server when this option is selected.
 
     
      
    
 
    
 
    [bookmark: pgfId-7831164]Tip Cisco recommends that you periodically save backups to a remote location so the appliance can be restored in case of system failure.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7831165]Step 7 You have the following options:
 
     
      
      	 [bookmark: pgfId-7831166]To save the backup file to the appliance, click  Start Backup . 
 
     
 
    
 
    [bookmark: pgfId-7831168]The backup file is saved [bookmark: marker-7831167]in the /var/sf/backup directory. You can direct the backup file to a remote location; see Managing Remote Storage.
 
    [bookmark: pgfId-7831172]When the backup process is complete, you can view the file on the Restoration Database page. For information about restoring a backup file, see Restoring the Appliance from a Backup File.
 
     
      
      	 [bookmark: pgfId-7831176]To save this configuration as a backup profile that you can use later, click  Save As New .
 
     
 
    
 
    [bookmark: pgfId-7831177]You can modify or delete the backup profile by selecting System > Tools > Backup/Restore, then clicking Backup Profiles. See Creating Backup Profiles for more information.
 
    [bookmark: pgfId-7831181]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7825125]To create a backup file of a physical managed device from the device itself:
 
    [bookmark: pgfId-7825129]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-7824977]Step 1 Select System > Tools > Backup/Restore.
 
    [bookmark: pgfId-7824978]The Device Backups page appears.
 
    [bookmark: pgfId-7824979]Step 2 Click Device Backup. 
 
    [bookmark: pgfId-7824980]The Create Backup page appears. 
 
    [bookmark: pgfId-7825178]Step 3 In the Name field, type a name for the backup file. You can use alphanumeric characters, punctuation, and spaces.
 
    [bookmark: pgfId-7825266]Step 4 Optionally, to be notified when the backup is complete, select the Email check box and type your email address in the accompanying text box.
 
     
      
    
 
    
 
    [bookmark: pgfId-7825269]Note To receive email notifications, you must configure a relay host as described in Configuring a Mail Relay Host and Notification Address.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7825274]Step 5 Optionally, to use secure copy (SCP) to copy the backup archive to a different machine, select the Copy when complete check box, then type the following information in the accompanying text boxes:
 
     
      
      	 [bookmark: pgfId-7825275]in the  Host field, the hostname or IP address of the machine where you want to copy the backup
 
      	 [bookmark: pgfId-7825276]in the  Path field, the path to the directory where you want to copy the backup
 
      	 [bookmark: pgfId-7825277]in the  User field, the user name you want to use to log into the remote machine
 
      	 [bookmark: pgfId-7825278]in the  Password field, the password for that user name
 If you prefer to access your remote machine with an SSH public key instead of a password, you must copy the contents of the  SSH Public Key field to the specified user’s  authorized_keys file on that machine.
 
     
 
    
 
    [bookmark: pgfId-7825279]With this option cleared, the system stores temporary files used during the backup on the remote server; temporary files are not stored on the remote server when this option is selected.
 
     
      
    
 
    
 
    [bookmark: pgfId-7825283]Tip Cisco recommends that you periodically save backups to a remote location so the appliance can be restored in case of system failure.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7825477]Step 6 You have the following options:
 
     
      
      	 [bookmark: pgfId-7825478]To save the backup file to the appliance, click  Start Backup . 
 
     
 
    
 
    [bookmark: pgfId-7825483]The backup file is saved [bookmark: marker-7825479]in the /var/sf/backup directory. On Defense Centers, you can direct the backup file to a remote location; see Managing Remote Storage.
 
    [bookmark: pgfId-7825487]When the backup process is complete, you can view the file on the Restoration Database page. For information about restoring a backup file, see Restoring the Appliance from a Backup File.
 
     
      
      	 [bookmark: pgfId-7825491]To save this configuration as a backup profile that you can use later, click  Save As New .
 
     
 
    
 
    [bookmark: pgfId-7825492]You can modify or delete the backup profile by selecting System > Tools > Backup/Restore, then clicking Backup Profiles. See Creating Backup Profiles for more information.
 
    [bookmark: pgfId-7825018]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7808295]To create a b[bookmark: marker-7825907]ackup file of a physical managed device from its managing Defense Center:
 
    [bookmark: pgfId-7808299]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-7808300]Step 1 Select System > Tools > Backup/Restore.
 
    [bookmark: pgfId-7255709]The Backup Management page appears.
 
    [bookmark: pgfId-7737290]Step 2 Click Managed Device Backup. 
 
    [bookmark: pgfId-7737294]The Create Backup page appears. 
 
    [bookmark: pgfId-7825855]Step 3 In the Managed Devices field, select one or more managed devices. Use the Shift or Ctrl keys to select multiple managed devices.
 
    [bookmark: pgfId-7825856]Step 4 To include unified files in addition to configuration data, select the Include All Unified Files check box.
 
    [bookmark: pgfId-7824405]Step 5 To save the backup file on the Defense Center, select the Retrieve to Defense Center check box. To save each device’s backup file on the device itself, leave this check box unselected.
 
     
      
    
 
    
 
    [bookmark: pgfId-7824642]Note If you select Retrieve to Defense Center and your Defense Center is configured for remote storage of backups, the device backup file will be saved to the configured remote location, not the Defense Center itself.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7824646]Step 6 Click Start Backup.
 
    [bookmark: pgfId-7825553]A success message appears and the backup task is created.
 
    [bookmark: pgfId-7825557]The backup file is saved in the /var/sf/backup directory. Using the Defense Center, you can direct the backup file to a remote location; see Managing Remote Storage.
 
    [bookmark: pgfId-7825561]When the backup process is complete, you can view the file on the Restoration Database page. For information about restoring a backup file, see Restoring the Appliance from a Backup File.
 
    [bookmark: pgfId-7773379]Step 7 Optionally, to save this configuration as a backup profile that you can use later, click Save As New.
 
    [bookmark: pgfId-7773380]You can modify or delete the backup profile by selecting System > Tools > Backup/Restore, then clicking Backup Profiles. See Creating Backup Profiles for more information.
 
    [bookmark: pgfId-7813184]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7823568][bookmark: 90686]Creating[bookmark: marker-7773385] Backup Profiles
 
    [bookmark: pgfId-7795650]License: Any
 
    [bookmark: pgfId-7822203]Supported Devices: Any except virtual, X-Series, and ASA FirePOWER
 
    [bookmark: pgfId-7822182]Supported Defense Centers: Any
 
    [bookmark: pgfId-7795360]You can use the Backup Profiles page to create backup profiles that contain the settings that you want to use for different types of backups. You can later select one of these profiles when you back up the files on your appliance.
 
     
      
    
 
    
 
    [bookmark: pgfId-7773404]Tip When you create a backup file as described in Creating Backup Files, a backup profile is automatically created.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7773405]To create a backup profile:
 
    [bookmark: pgfId-7773406]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-7773407]Step 1 Select System > Tools > Backup/Restore.
 
    [bookmark: pgfId-7773408]The Backup Management page appears.
 
    [bookmark: pgfId-7773409]Step 2 Click the Backup Profiles tab.
 
    [bookmark: pgfId-7773410]The Backup Profiles page appears with a list of existing backup profiles.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7773416]Step 3 Click Create Profile.
 
   [bookmark: pgfId-7773417]The Create Backup page appears.
 
   [bookmark: pgfId-7773418]Step 4 Type a name for the backup profile. You can use alphanumeric characters, punctuation, and spaces.
 
   [bookmark: pgfId-7773420]Step 5 Configure the backup profile according to your needs.
 
   [bookmark: pgfId-7773424]See Creating Backup Files for more information about the options on this page.
 
   [bookmark: pgfId-7773425]Step 6 Click Save As New to save the backup profile.
 
   [bookmark: pgfId-7773426]The Backup Profiles page appears and your new profile appears in the list.
 
   [bookmark: pgfId-7826358]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7784333][bookmark: 42599]Uploading Backups from a Local Host
 
    [bookmark: pgfId-7795316]License: Any
 
    [bookmark: pgfId-7827359]Supported Devices: Series 2 and Series 3
 
    [bookmark: pgfId-7827338]Supported Defense Centers: Any
 
    [bookmark: pgfId-7807700]If you download a backup file to your local host using the download function described in the Backup Management table, you can upload it to a Defense Center.
 
    [bookmark: pgfId-7815908]If your backup file contains PKI objects, private keys associated with internal CA and internal certificate objects are re-encrypted on upload with a randomly generated key.
 
     
      
    
 
    
 
    [bookmark: pgfId-7807708]Tip You cannot upload a backup larger than 4GB from your local host because web browsers do not support uploading files that large. As an alternative, copy the backup via SCP to a remote host and retrieve it from there. On Defense Centers, the backup file can be saved to and retrieved from a remote location; see Managing Remote Storage.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7258834]To upload a backup from your local host:
 
    [bookmark: pgfId-7258835]Access: Admin/Maint
 
    
 
    [bookmark: pgfId-7776353]Step 1 Select System > Tools > Backup/Restore.
 
    [bookmark: pgfId-7258837]The Backup Management page appears.
 
    [bookmark: pgfId-7258838]Step 2 Click Upload Backup.
 
    [bookmark: pgfId-7258839]The Upload Backup page appears.
 
    [bookmark: pgfId-7258840]Step 3 Click Browse and navigate to the backup file you want to upload.
 
    [bookmark: pgfId-7258841]After you select the file to upload, click Upload Backup.
 
    [bookmark: pgfId-7258842]Step 4 Click Backup Management to return to the Backup Management page.
 
    [bookmark: pgfId-7258843]The backup file is uploaded and appears in the backup list. After the Defense Center appliance verifies the file integrity, refresh the Backup Management page to reveal detailed file system information.
 
    [bookmark: pgfId-7813227]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-1759625][bookmark: 16670]Restor[bookmark: marker-1759621]ing the Appliance from a Backup File
 
    [bookmark: pgfId-7832607]License: Any
 
    [bookmark: pgfId-7832617]Supported Devices: Series 2 and Series 3
 
    [bookmark: pgfId-7832621]Supported Defense Centers: Any
 
    [bookmark: pgfId-7801762]You can restore the appliance from backup files using the Backup Management page. To restore a backup, the VDB version in the backup file must match the current VDB version on your appliance. After you complete the restoration process, you must apply the latest Sourcefire Rule Update.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7801819] 
     Caution Do not restore backups created on virtual Defense Centers to physical Defense Centers — this may stress system resources. If you must restore a virtual backup on a physical Defense Center, contact Support. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7815913]If your backup file contains PKI objects, private keys associated with internal CA and internal certificate objects are reencrypted on upload with a randomly generated key.
 
    [bookmark: pgfId-7808029]If you use local storage, backup files are saved to /var/sf/backup, which is listed with the amount of disk space used in the /var partition at the bottom of the Backup Management page. On Defense Centers, select Remote Storage at the top of the Backup Management page to configure remote storage options; then, to enable remote storage, select the Enable Remote Storage for Backups check box on the Backup Management page. If you use remote storage, the protocol, backup system, and backup directory are listed at the bottom of the page. 
 
     
      
    
 
    
 
    [bookmark: pgfId-7803516]Note If you add licenses after a backup has completed, these licenses will not be removed or overwritten if this backup is restored. To prevent a conflict on restore, remove those licenses before restoring the backup, noting where the licenses were used, and add and reconfigure them after restoring the backup. If a conflict occurs, contact Support.
 
     
     
 
    
 
    
 
     
      
       
       [bookmark: pgfId-1773354]Table 70-2 [bookmark: 90577]Backup Management 
 
       
       
        
        	 
          
          [bookmark: pgfId-1773358]Functionality 
         
  
        	 
          
          [bookmark: pgfId-1773360]Description 
         
  
       
 
        
        	[bookmark: pgfId-7256250]System Information
  
        	[bookmark: pgfId-7256252]The originating appliance name, type, and version. Note that you can only restore a backup to an identical appliance type and version.
  
       
 
        
        	[bookmark: pgfId-7256238]Date Created
  
        	[bookmark: pgfId-7256240]The date and time that the backup file was created
  
       
 
        
        	[bookmark: pgfId-1773366]File Name
  
        	[bookmark: pgfId-1773368]The full name of the backup file
  
       
 
        
        	[bookmark: pgfId-7803306]VDB Version
  
        	[bookmark: pgfId-7803308]The build of the vulnerability database (VDB) running on the appliance at the time of backup. 
  
       
 
        
        	[bookmark: pgfId-7312224]Location
  
        	[bookmark: pgfId-7312226]The location of the backup file
  
       
 
        
        	[bookmark: pgfId-1773370]Size (MB)
  
        	[bookmark: pgfId-1773372]The size of the backup file, in megabytes
  
       
 
        
        	[bookmark: pgfId-7256942]Events?
  
        	[bookmark: pgfId-7256944]“Yes” indicates the backup includes event data
  
       
 
        
        	[bookmark: pgfId-1773378]View
  
        	[bookmark: pgfId-1773380]Click the name of the backup file to view a list of the files included in the compressed backup file.
  
       
 
        
        	[bookmark: pgfId-1773382]Restore
  
        	[bookmark: pgfId-1773387]Click with the backup file selected to restore it on the appliance. If your VDB version does not match the VDB version in the backup file, this option is disabled.
  
       
 
        
        	[bookmark: pgfId-1773389]Download
  
        	[bookmark: pgfId-1773391]Click with the backup file selected to save it to your local computer.
  
       
 
        
        	[bookmark: pgfId-7257065]Delete
  
        	[bookmark: pgfId-7257067]Click with the backup file selected to delete it.
  
       
 
        
        	[bookmark: pgfId-1773393]Move
  
        	[bookmark: pgfId-1773395]On a Defense Center, when you have a previously created local backup selected, click to send the backup to the designated remote backup location.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1759686]To restore the appliance from a backup file:
 
    [bookmark: pgfId-6955906]Access: Admin
 
    
 
    [bookmark: pgfId-7773829]Step 1 Select System > Tools > Backup/Restore.
 
    [bookmark: pgfId-7773833]The Backup Management page appears.
 
    [bookmark: pgfId-5171103]Step 2 To view the contents of a backup file, click the name of the file.
 
    [bookmark: pgfId-5171108]The manifest appears, listing the name of each file, its owner and permissions, and its file size and date.
 
    [bookmark: pgfId-1759691]Step 3 Click Backup Management to return to the Backup Management page.
 
    [bookmark: pgfId-5171283]Step 4 Select the backup file that you want to restore and click Restore.
 
    [bookmark: pgfId-1759692]The Restore Backup page appears.
 
    [bookmark: pgfId-7791113]Note that if the VDB version in the backup does not match the VDB version currently installed on your appliance, the Restore button is grayed out.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-5911160] 
     Caution This procedure overwrites all configuration files and, on the managed device, all event data. 
      
      
 
     
 
    
 
    [bookmark: pgfId-5911164]Step 5 To restore files, select either or both:
 
     
      
      	 [bookmark: pgfId-7313035] Replace Configuration Data 
 
      	 [bookmark: pgfId-7313043] Restore Event Data 
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7780479]Note Note that, when you restore the configuration of a managed device from a backup file, any device configuration changes you made from the device’s managing Defense Center will also be restored, even changes you made after you created that backup file.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-1759705]Step 6 Click Restore to begin the restoration.
 
    [bookmark: pgfId-1759710]The appliance is restored using the backup file you specified.
 
    [bookmark: pgfId-6381705]Step 7 Reboot the appliance.
 
    [bookmark: pgfId-7727818]Step 8 Apply the latest Sourcefire Rule Update to reapply rule updates.
 
    [bookmark: pgfId-5907317]Step 9 Reapply any access control, intrusion, network discovery, health, and system policies to the restored system.
 
    [bookmark: pgfId-7813233]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2514234]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-3298589][bookmark: 72067]Specify[bookmark: marker-3298587]ing User Preferences 
      
      
 
     
 
 
    [bookmark: pgfId-3255257]You can configure the preferences that are tied to a single user account, such as the home page, account password, time zone, dashboard, and event viewing preferences.
 
    [bookmark: pgfId-1326067]Depending on your user role, you can specify certain preferences for your user account, including passwords, event viewing preferences, time zone settings, and home page preferences. See the following sections for more information:
 
     
     	 [bookmark: pgfId-1169585]Changing Your Password explains how to change the password for your user account.
 
     	 [bookmark: pgfId-3272872]Specifying Your Home Page explains how to use one of the existing pages as your default home page. After setting this value, this becomes the first page you see upon logging into the appliance.
 
     	 [bookmark: pgfId-3256190]Configuring Event View Settings describes how the event preferences affect what you see as you view events.
 
     	 [bookmark: pgfId-1169591]Setting Your Default Time Zone explains how to set the time zone for your user account and describes how that affects the time stamp on the events that you view.
 
     	 [bookmark: pgfId-3256198]Specifying Your Default Dashboard explains how to choose which of the dashboards you want to use as your default dashboard.
 
    
 
   
 
    
     [bookmark: pgfId-1167420][bookmark: 13943]Changing Your Pa[bookmark: marker-1167419]ssword
 
    [bookmark: pgfId-3299104]License: Any
 
    [bookmark: pgfId-3299114]Supported Devices: Series 2, Series 3
 
    [bookmark: pgfId-3299115]Supported Defense Centers: Any
 
    [bookmark: pgfId-3270844]All user accounts are protected with a password. You can change your password at any time, and depending on the settings for your user account, you may have to change your password periodically; see Changing an Expired Password. 
 
    [bookmark: pgfId-2877668]Note that if password strength checking is enabled, passwords must be at least eight alphanumeric characters of mixed case and must include at least one numeric character. Passwords cannot be a word that appears in a dictionary or include consecutive repeating characters.
 
     
      
    
 
    
 
    [bookmark: pgfId-1892841]Note If you are an LDAP or a RADIUS user, you cannot change your password through the web interface.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-3298718]To change your password:
 
    [bookmark: pgfId-3298722]Access: Any
 
    
 
    [bookmark: pgfId-3298723]Step 1 From the drop-down list under your user name, select User Preferences.
 
    [bookmark: pgfId-1167426]The Change Password page appears.
 
    [bookmark: pgfId-1340915]Step 2 In the Current Password field, type your current password and click Change.
 
    [bookmark: pgfId-1167428]Step 3 In the New Password and Confirm fields, type your new password. 
 
    [bookmark: pgfId-1167429]Step 4 Click Change.
 
    [bookmark: pgfId-1167430]A success message appears on the page when your new password is accepted by the system.
 
    [bookmark: pgfId-3303662]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-2877358][bookmark: 67075]Changing an Expired Password
 
     [bookmark: pgfId-3256238]License: Any
 
     [bookmark: pgfId-3283916]Supported Devices: Series 2, Series 3
 
     [bookmark: pgfId-3283917]Supported Defense Centers: Any
 
     [bookmark: pgfId-2877370]Depending on the settings for your user account, your password may expire. Note that the password expiration time period is set when your account is created and cannot be changed. If your password has expired, the Password Expiration Warning page appears.
 
     [bookmark: pgfId-2877486]To respond to the password expiration warning:
 
     [bookmark: pgfId-2877514]Access: Any
 
     
 
     [bookmark: pgfId-2877372]Step 1 You have two choices:
 
      
       
       	 [bookmark: pgfId-2877373]Click  Change Password to change your password now. 
 
      
 
     
 
     [bookmark: pgfId-2877705]If you have zero warning days left, you must change your password. Also, if password strength checking is enabled, passwords must be at least eight alphanumeric characters of mixed case and must include at least one numeric character. Passwords cannot be a word that appears in a dictionary or include consecutive repeating characters.
 
      
       
       	 [bookmark: pgfId-2877374]Click  Skip to change your password later.
 
      
 
     
 
     [bookmark: pgfId-3303692]
 
      
      
 
     
 
     
 
    
 
   
 
    
     [bookmark: pgfId-3272810][bookmark: 12687]Specifying Your Ho[bookmark: marker-3272809]me Page
 
    [bookmark: pgfId-3272812]License: Any
 
    [bookmark: pgfId-3272813]You can specify a page within the web interface as your home page for the appliance. The default home page is the Summary Dashboard (Overview > Dashboards), except for user accounts with no dashboard access, which use the Welcome page.
 
    [bookmark: pgfId-3272814]To specify your home page:
 
    [bookmark: pgfId-3272815]Access: Any except External Database User
 
    
 
    [bookmark: pgfId-3272816]Step 1 From the drop-down list under your user name, select User Preferences.
 
    [bookmark: pgfId-3272817]The Change Password page appears.
 
    [bookmark: pgfId-3272818]Step 2 Click Home Page.
 
    [bookmark: pgfId-3272819]The Home Page page appears.
 
    [bookmark: pgfId-3272824]Step 3 Select the page you want to use as your home page from the drop-down list. 
 
    [bookmark: pgfId-3272825]The options in the drop-down list are based on the access privileges for your user account. For more information, see User Account Privileges.
 
    [bookmark: pgfId-3272829]Step 4 Click Save.
 
    [bookmark: pgfId-3272782]Your home page preference is saved.
 
    [bookmark: pgfId-3303705]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3256246][bookmark: 66845]Configuring Event[bookmark: marker-3256245] View Settings
 
    [bookmark: pgfId-3256258]License: Any
 
    [bookmark: pgfId-3256261]Use the Event View Settings page to configure characteristics of event views in the FireSIGHT System. Note that some event view configurations are available only for specific user roles. Users with the External Database User role can view parts of the event view settings user interface, but changing those settings has no meaningful result. For details, see the individual sections linked below.
 
    [bookmark: pgfId-3256263]To configure event preferences:
 
    [bookmark: pgfId-3256264]Access: feature dependent
 
    
 
    [bookmark: pgfId-3256265]Step 1 From the drop-down list under your user name, select User Preferences.
 
    [bookmark: pgfId-3256266]The User Preferences page appears.
 
    [bookmark: pgfId-3256267]Step 2 Click Event View Settings.
 
    [bookmark: pgfId-3256268]The Event View Settings page appears.
 
    [bookmark: pgfId-3287814]Step 3 Configure the basic characteristics of event views.
 
    [bookmark: pgfId-3287818]For more information, see Event Preferences.
 
    [bookmark: pgfId-3290524]Step 4 Configure file download preferences.
 
    [bookmark: pgfId-3290579]For more information, see File Preferences.
 
    [bookmark: pgfId-3287819]Step 5 Configure the default time window or windows.
 
    [bookmark: pgfId-3256278]For more information, see Default Time Windows.
 
    [bookmark: pgfId-3256279]Step 6 Configure default workflows.
 
    [bookmark: pgfId-3256283]For more information, see Default Workflows.
 
    [bookmark: pgfId-3256284]Step 7 Click Save.
 
    [bookmark: pgfId-3256285]Your changes are implemented.
 
    [bookmark: pgfId-3303719]
 
     
     
 
    
 
    
 
     
      [bookmark: pgfId-3290505][bookmark: 16019]Event Preferences
 
     [bookmark: pgfId-3290506]License: Any
 
     [bookmark: pgfId-3290507]Use the Event Preferences section of the Event View Settings page to configure basic characteristics of event views in the FireSIGHT System. This section is available for all user roles, although it has little to no significance for users who cannot view events.
 
     [bookmark: pgfId-3273264]The following fields appear in the Event Preferences section:
 
      
      	 [bookmark: pgfId-3273266]The  Confirm “All” Actions  field controls whether the appliance forces you to confirm actions that affect all events in an event view.
 
     
 
     [bookmark: pgfId-3256299]For example, if this setting is enabled and you click Delete All on an event view, you must confirm that you want to delete all the events that meet the current constraints (including events not displayed on the current page) before the appliance will delete them from the database.
 
      
      	 [bookmark: pgfId-3256301]The  Resolve IP Addresses  field allows the appliance, whenever possible, to display host names instead of IP addresses in event views.
 
     
 
     [bookmark: pgfId-3256302]Note that an event view may be slow to display if it contains a large number of IP addresses and you have enabled this option. Note also that for this setting to take effect, you must have a DNS server configured in the system settings; see Configuring Management Interfaces.
 
      
      	 [bookmark: pgfId-3309546]The  Expand Packet View field allows you to configure how the packet view for intrusion events appears. By default, the appliance displays a collapsed version of the packet view:
 
     
 
     [bookmark: pgfId-3309547] – None - collapse all subsections of the Packet Information section of the packet view
 
     [bookmark: pgfId-3309548] – Packet Text - expand only the Packet Text subsection
 
     [bookmark: pgfId-3309549] – Packet Bytes - expand only the Packet Bytes subsection
 
     [bookmark: pgfId-3309550] – All - expand all sections
 
     [bookmark: pgfId-3309551]Regardless of the default setting, you can always manually expand the sections in the packet view to view detailed information about a captured packet. For more information on the packet view, see Using the Packet View.
 
      
      	 [bookmark: pgfId-3307515]The  Rows Per Page field controls how many rows of events per page you want to appear in drill-down pages and table views.
 
      	 [bookmark: pgfId-3256319]The  Refresh Interval field sets the refresh interval for event views in minutes. Entering  0 disables the refresh option. Note that this interval does not apply to dashboards.
 
      	 [bookmark: pgfId-3308233]The  Statistics Refresh Interval controls the refresh interval for event summary pages such as the Intrusion Event Statistics and Discovery Statistics pages. Entering  0 disables the refresh option. Note that this interval does not apply to dashboards.
 
      	 [bookmark: pgfId-3308499]The  Deactivate Rules field controls which links appear on the packet view of intrusion events generated by standard text rules:
 
     
 
     [bookmark: pgfId-3308644] – All Policies - a single link that deactivates the standard text rule in all the locally defined custom intrusion policies
 
     [bookmark: pgfId-3308837] – Current Policy - a single link that deactivates the standard text rule in only the currently applied intrusion policy. Note that you cannot deactivate rules in the default policies.
 
     [bookmark: pgfId-3309041] – Ask - links for each of these options
 
     [bookmark: pgfId-3309094]To see these links on the packet view, your user account must have either Administrator or Intrusion Admin access.
 
    
 
     
      [bookmark: pgfId-3284800][bookmark: 72698]File [bookmark: marker-3293797]Preferences
 
     [bookmark: pgfId-3287051]License: Any
 
     [bookmark: pgfId-3287052]Supported Devices: feature dependent
 
     [bookmark: pgfId-3287939]Supported Defense Centers: feature dependent
 
     [bookmark: pgfId-3287053]Use the File Preferences section of the Event View Settings page to configure basic characteristics of local file downloads. This section is only available to users with the Administrator, Security Analyst, or Security Analyst (Read Only) user roles.
 
     [bookmark: pgfId-3288776]Note that if your appliance does not support downloading captured files, these options are disabled. Because you cannot use a Malware license with a DC500, you cannot use those appliances to download files or modify these options.
 
     [bookmark: pgfId-3256342]The following fields appear in the File Preferences section:
 
      
      	 [bookmark: pgfId-3292391]The  Confirm ‘Download File’ Actions check box controls whether a File Download pop-up window appears each time you download a file, displaying a warning and prompting you to continue or cancel. 
 
     
 
      
       
     
 
     
 
      
      [bookmark: pgfId-3293235] 
      Caution Cisco strongly recommends you do 
      not download malware, as it can cause adverse consequences. Exercise caution when downloading any file, as it may contain malware. Ensure you have taken any necessary precautions to secure the download destination before downloading files. 
       
       
 
      
 
     
 
     [bookmark: pgfId-3292754]Note that you can disable this option any time you download a file. For more information on downloading files, see Downloading Stored Files to Another Location.
 
      
      	 [bookmark: pgfId-3285291]When you download a captured file, the system creates a password-protected .zip archive containing the file. The  Zip File Password field defines the password you want to use to restrict access to the .zip file. If you leave this field blank, the system creates archive files without passwords.
 
      	 [bookmark: pgfId-3287174]The  Show Zip File Password check box toggles displaying plain text or obfuscated characters in the  Zip File Password field. When this field is cleared, the  Zip File Password displays obfuscated characters. 
 
     
 
    
 
     
      [bookmark: pgfId-3285179][bookmark: 83202]Default Ti[bookmark: marker-3256341]me Windows
 
     [bookmark: pgfId-3256353]License: Any
 
     [bookmark: pgfId-3256354]The time window, sometimes called the time range, imposes a time constraint on the events in any event view. Use the Default Time Windows section of the Event View Settings page to control the default behavior of the time window.
 
     [bookmark: pgfId-3291555]User role access to this section is as follows:
 
      
      	 [bookmark: pgfId-3291626]Administrators and Maintenance Users can access the full section.
 
      	 [bookmark: pgfId-3291694]Security Analysts and Security Analysts (Read Only) can access all options except  Audit Log Time Window .
 
      	 [bookmark: pgfId-3291845]Access Admins, Discovery Admins, External Database Users, Intrusion Admins, Network Admins, and Security Approvers can access only the  Events Time Window  option.
 
     
 
     [bookmark: pgfId-3256362]Note that, regardless of the default time window setting, you can always manually change the time window for individual event views during your event analysis. Also, keep in mind that time window settings are valid for only the current session. When you log out and then log back in, time windows are reset to the defaults you configured on this page. For more information, see Setting Event Time Constraints.
 
     [bookmark: pgfId-3256366]There are three types of events for which you can set the default time window:
 
      
      	 [bookmark: pgfId-3256367]The  Events Time Window sets a single default time window for most events that can be constrained by time.
 
      	 [bookmark: pgfId-3256377]The  Audit Log Time Window sets the default time window for the audit log.
 
      	 [bookmark: pgfId-3256378]The  Health Monitoring Time Window sets the default time window for health events.
 
     
 
     [bookmark: pgfId-3256379]You can only set time windows for event types your user account can access. All user types can set event time windows. Administrators, Maintenance Users, and Security Analysts can set health monitoring time windows. Administrators and Maintenance Users can set audit log time windows.
 
     [bookmark: pgfId-3256386]Note that because not all event views can be constrained by time, time window settings have no effect on event views that display hosts, host attributes, applications, clients, vulnerabilities, user identity, or white list violations.
 
     [bookmark: pgfId-3256393]You can either use Multiple time windows, one for each of these types of events, or you can use a Single time window that applies to all events. If you use a single time window, the settings for the three types of time window disappear and a new Global Time Window setting appears.
 
     [bookmark: pgfId-3256398]There are three types of time window:
 
      
      	 [bookmark: pgfId-3256399] static , which displays all the events generated from a specific start time to a specific end time
 
      	 [bookmark: pgfId-3256400] expanding , which displays all the events generated from a specific start time to the present; as time moves forward, the time window expands and new events are added to the event view
 
      	 [bookmark: pgfId-3256401] sliding , which displays all the events generated from a specific start time (for example, one day ago) to the present; as time moves forward, the time window “slides” so that you see only the events for the range you configured (in this example, for the last day)
 
     
 
     [bookmark: pgfId-3256402]The maximum time range for all time windows is from midnight on January 1, 1970 (UTC) to 3:14:07 AM on January 19, 2038 (UTC).
 
     [bookmark: pgfId-3256403]The following options appear in the Time Window Settings drop-down list:
 
      
      	 [bookmark: pgfId-3272529]The  Show the Last - Sliding option allows you configure a sliding default time window of the length you specify. 
 
     
 
     [bookmark: pgfId-3272561]The appliance displays all the events generated from a specific start time (for example, 1 hour ago) to the present. As you change event views, the time window “slides” so that you always see events from the last hour.
 
      
      	 [bookmark: pgfId-3272421]The  Show the Last - Static/Expanding  option allows you to configure either a static or expanding default time window of the length you specify.
 
     
 
     [bookmark: pgfId-3272422]For static time windows, enable the Use End Time check box. The appliance displays all the events generated from a specific start time (for example, 1 hour ago) to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.
 
     [bookmark: pgfId-3256410]For expanding time windows, disable the Use End Time check box. The appliance displays all the events generated from a specific start time (for example, 1 hour ago) to the present. As you change event views, the time window expands to the present time.
 
      
      	 [bookmark: pgfId-3256411]The  Current Day - Static/Expanding option allows you to configure either a static or expanding default time window for the current day. The current day begins at midnight, based on the time zone setting for your current session.
 
     
 
     [bookmark: pgfId-3256413]For static time windows, enable the Use End Time check box. The appliance displays all the events generated from midnight to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.
 
     [bookmark: pgfId-3256414]For expanding time windows, disable the Use End Time check box. The appliance displays all the events generated from midnight to the present. As you change event views, the time window expands to the present time. Note that if your analysis continues for over 24 hours before you log out, this time window can be more than 24 hours.
 
      
      	 [bookmark: pgfId-3256415]The  Current Week - Static/Expanding option allows you to configure either a static or expanding default time window for the current week. The current week begins at midnight on the previous Sunday, based on the time zone setting for your current session.
 
     
 
     [bookmark: pgfId-3256417]For static time windows, enable the Use End Time check box. The appliance displays all the events generated from midnight to the time when you first viewed the events. As you change event views, the time window stays fixed so that you see only the events that occurred during the static time window.
 
     [bookmark: pgfId-3256418]For expanding time windows, disable the Use End Time check box. The appliance displays all the events generated from midnight Sunday to the present. As you change event views, the time window expands to the present time. Note that if your analysis continues for over 1 week before you log out, this time window can be more than 1 week.
 
    
 
     
      [bookmark: pgfId-3256421][bookmark: 45384]Default Work[bookmark: marker-3256420]flows
 
     [bookmark: pgfId-3256432]License: Any
 
     [bookmark: pgfId-3256433]A workflow is a series of pages displaying data that analysts use to evaluate events. For each event type, the appliance ships with at least one predefined workflow. For example, as a Security Analyst, depending on the type of analysis you are performing, you can choose among ten different intrusion event workflows, each of which presents intrusion event data in a different way.
 
     [bookmark: pgfId-3256434]The appliance is configured with a default workflow for each event type. For example, the Events by Priority and Classification workflow is the default for intrusion events. This means whenever you view intrusion events (including reviewed intrusion events), the appliance displays the Events by Priority and Classification workflow. 
 
     [bookmark: pgfId-3256435]You can, however, change the default workflow for each event type using the Default Workflows sections of the Event View Settings page.
 
     [bookmark: pgfId-3256436]Keep in mind that the default workflows you are able to configure depend on your user role. For example, intrusion event analysts cannot set default discovery event workflows. For general information on workflows, see Understanding and Using Workflows.
 
    
 
   
 
    
     [bookmark: pgfId-3179851][bookmark: 55342]Setting Your Defau[bookmark: marker-3179849]lt Time Zone
 
    [bookmark: pgfId-3256471]License: Any
 
    [bookmark: pgfId-1167569]You can change the time zone used to display events from the standard UTC time that the appliance uses. When you configure a time zone, it applies only to your user account and is in effect until you make further changes to the time zone.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-3256476] 
     Caution The Time Zone function assumes that the default system clock is set to UTC time. If you have changed the system clock on the appliance to use a local time zone, you must change it back to UTC time in order to view accurate local time on the appliance. For more information about time synchronization between the Defense Center and the managed devices, see 
     Synchronizing Time. 
      
      
 
     
 
    
 
    [bookmark: pgfId-3136897]To change your time zone:
 
    [bookmark: pgfId-2593103]Access: Any
 
    
 
    [bookmark: pgfId-1319811]Step 1 From the drop-down list under your user name, select User Preferences.
 
    [bookmark: pgfId-1319812]The Change Password page appears.
 
    [bookmark: pgfId-1319813]Step 2 Click Time Zone Settings.
 
    [bookmark: pgfId-1167579]The Time Zone Preference page appears.
 
    [bookmark: pgfId-1341191]Step 3 From the left list box, select the continent or area that contains the time zone you want to use.
 
    [bookmark: pgfId-1167585]For example, if you want to use a time zone standard to North America, South America, or Canada, select America.
 
    [bookmark: pgfId-1167586]Step 4 From the right list box, select the zone (city name) that corresponds with the time zone you want to use.
 
    [bookmark: pgfId-1167587]For example, if you want to use Eastern Standard Time, you would select New York after selecting America in the first time zone box.
 
    [bookmark: pgfId-1167588]Step 5 Click Save.
 
    [bookmark: pgfId-1167589]The time zone is set.
 
    [bookmark: pgfId-3303745]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-3256528][bookmark: 93031]Specifying Your Def[bookmark: marker-3256527]ault Dashboard
 
    [bookmark: pgfId-3256539]License: Any
 
    [bookmark: pgfId-3256541]You can specify one of the dashboards on the appliance as the default dashboard. The default dashboard appears when you select Overview > Dashboards. If you do not have a default dashboard defined, the Dashboard List page appears. For general information on dashboards, see Using Dashboards.
 
    [bookmark: pgfId-3256545]To specify your default dashboard:
 
    [bookmark: pgfId-3256546]Access: Admin/Maint/Any Security Analyst
 
    
 
    [bookmark: pgfId-3256547]Step 1 From the drop-down list under your user name, select User Preferences.
 
    [bookmark: pgfId-3256548]The Change Password page appears.
 
    [bookmark: pgfId-3256549]Step 2 Click Dashboard Settings.
 
    [bookmark: pgfId-3256550]The Dashboard Settings page appears.
 
    [bookmark: pgfId-3256555]Step 3 Select the dashboard you want to use as your default from the drop-down list.
 
    [bookmark: pgfId-3256556]If you select None, when you select Overview > Dashboards, the Dashboard List page appears. You can then select a dashboard to view.
 
    [bookmark: pgfId-3256557]Step 4 Click Save.
 
    [bookmark: pgfId-3256558]Your default dashboard preference is saved.
 
    [bookmark: pgfId-3303751]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2660514]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7891710][bookmark: 56385]Importing and[bookmark: marker-7891708] Exporting Configurations 
      
      
 
     
 
 
    [bookmark: pgfId-7882069]You can use the Import/Export feature to copy several types of configurations, including policies, from one appliance to another appliance of the same type. Configuration import and export is not intended as a backup tool, but can be used to simplify the process of adding new appliances to your FireSIGHT System.
 
    [bookmark: pgfId-7742978]You can import and export the following configurations:
 
     
     	 [bookmark: pgfId-7864168]access control policies and their associated network analysis, SSL, and file policies
 
     	 [bookmark: pgfId-7899453]intrusion policies
 
     	 [bookmark: pgfId-7899481]health and system policies
 
     	 [bookmark: pgfId-7864152]alert responses
 
     	 [bookmark: pgfId-7864215]application detectors
 
     	 [bookmark: pgfId-7838832]dashboards, custom tables, custom workflows, and saved searches
 
     	 [bookmark: pgfId-7825221]custom user roles
 
     	 [bookmark: pgfId-7832959]report templates
 
     	 [bookmark: pgfId-7819223]third-party product and vulnerability mappings
 
    
 
    [bookmark: pgfId-7832678]To import an exported configuration, both appliances must be running the same version of the FireSIGHT System. To import an exported intrusion or access control policy, the rule update versions on both appliances must also match.
 
    [bookmark: pgfId-7832685]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-7832689]Exporting Configurations
 
     	 [bookmark: pgfId-5908582]Importing Configurations
 
    
 
   
 
    
     [bookmark: pgfId-7889770][bookmark: 89678]Exporting[bookmark: marker-7889769] Configurations
 
    [bookmark: pgfId-7889771]License: Any
 
    [bookmark: pgfId-7889772]You can export a single configuration, or you can export a set of configurations (of the same type or of different types) at once. When you later import the package onto another appliance, you can choose which configurations in the package to import.
 
    [bookmark: pgfId-7743541]When you export a configuration, the appliance also exports revision information for that configuration. The FireSIGHT System uses that information to determine whether you can import that configuration onto another appliance; you cannot import a configuration revision that already exists on an appliance.
 
    [bookmark: pgfId-7868280]In addition, when you export a configuration, the appliance also exports system configurations that the configuration depends on, such as authentication objects. For example, if you set up authentication to an LDAP server on your Defense Center, then export a Defense Center system policy with authentication enabled, the authentication object is exported as well.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7868313]You can export the following configurations:
 
    
    	 [bookmark: pgfId-7843329] Alert responses — An alert response is a set of configurations that allows the FireSIGHT System to interact with the external system where you plan to send the alert.
 
    	 [bookmark: pgfId-7843330] Custom tables — A custom table is a table you can construct that combines fields from two or more of the predefined tables delivered with the FireSIGHT System.
 
    	 [bookmark: pgfId-7843331] Custom user roles — A custom user role is a user role that you create with a specialized set of access privileges. Exporting a custom user role that requires saved searches also exports all of the necessary saved searches.
 
    	 [bookmark: pgfId-7864657] Custom workflows — A custom workflow is a workflow that you create to meet the unique needs of your organization. On the Defense Center, you can export custom workflows that you create as well as the predefined custom workflows delivered with the appliance.
 
   
 
   [bookmark: pgfId-7843332]Note that if a Defense Center does not allow you to view the table on which an exported custom workflow is based, you can import the workflow but will not be able to view it.
 
    
    	 [bookmark: pgfId-7864692] Dashboards — A dashboard is a customizable tabbed view that provides you with an at-a-glance display of your current system status. Dashboards use various widgets to present data about the events collected and generated by the FireSIGHT System, as well as information about the status and overall health of the appliances in your deployment.
 
   
 
   [bookmark: pgfId-7843333]Note that the dashboard widgets that you can view depend on the type of appliance you are using and on your user role. For more information, see Understanding Widget Availability.
 
    
    	 [bookmark: pgfId-7843334] Access control policies — Access control policies include a variety of components that you can configure to determine how the system manages traffic on your network. These components include access control rules; associated intrusion, file, network analysis, and SSL policies; and objects the rules and policies use, including intrusion variable sets. Exporting an access control policy exports all settings and components for the policy except (where present) URL reputations and categories, which are equivalent across appliances and which users cannot change. Any custom URL objects or groups referenced in the access control policy are included when the policy is exported. Note that to import an access control policy, the rule update version on the exporting and importing Defense Center must match. Note that to import an access control policy, the rule update version on the exporting and importing Defense Center must match.
 
   
 
   [bookmark: pgfId-7885176]If an access control policy that you export, or the SSL policy it invokes, contains rules that reference geolocation data, the importing Defense Center’s geolocation database (GeoDB) update version is used.
 
   [bookmark: pgfId-7900058]PKI objects containing private key information are encrypted with a randomly generated key when stored on the appliance. If an access control policy that you export references an SSL policy that uses PKI objects containing private keys, the private keys are decrypted before export.
 
   [bookmark: pgfId-7881136]If an access control policy that you export references an unsupported DC500 or Series 2 device policy feature or rule condition, you cannot use a DC500 to apply the policy and you cannot apply the policy to a Series 2 device. Neither the DC500 nor Series 2 devices support user or URL rule conditions, Security Intelligence, or file policies that include rules that use the Block Malware or Malware Cloud Lookup action. Additionally, Series 2 devices do not support application rule conditions.
 
    
    	 [bookmark: pgfId-7843335] Health policies — A health policy comprises the criteria used when checking the health of appliances in your deployment, that is, whether your Cisco hardware and software are working correctly.
 
    	 [bookmark: pgfId-7865137] Intrusion policies — Intrusion policies include a variety of components that you can configure to inspect your network traffic for intrusions and policy violations. These components intrusion rules that inspect the protocol header values, payload content, and certain packet size characteristics; FireSIGHT recommended rules configurations; and other advanced settings.
 
   
 
   [bookmark: pgfId-7899250]Exporting an intrusion policy exports all settings for the policy. For example, if you choose to set a rule to generate events, or if you set SNMP alerting for a rule, or if you turn on the sensitive data preprocessor in a policy, those settings remain in place in the exported policy. Custom rules, custom rule classifications, and user-defined variables are also exported with the policy.
 
   [bookmark: pgfId-7899251]Note that if you export an intrusion policy that uses a layer that is shared by a second intrusion policy, that shared layer is copied into the policy you are exporting and the sharing relationship is broken. When you import the intrusion policy on another appliance, you can edit the imported policy to suit your needs, including deleting, adding, and sharing layers.
 
   [bookmark: pgfId-7879837]If you export an intrusion policy from one Defense Center to another, the imported policy may behave differently if the second Defense Center has differently configured default variables.
 
    
     
   
 
   
 
   [bookmark: pgfId-7843336]Note You cannot use the Import/Export feature to update rules created by Cisco’s Vulnerability Research Team (VRT). Instead, download and apply the latest rule update version; see Importing Rule Updates and Local Rule Files.
 
    
    
 
   
 
   
 
    
    	 [bookmark: pgfId-7843337] Report templates — Reports are document files formatted in PDF, HTML, or CSV that collate specific FireSIGHT System data. A report template specifies the data searches and formats for the report and its sections. When you export a report template, all saved searches, images, objects created in the object manager, and custom tables that are necessary for the report are exported also.
 
    	 [bookmark: pgfId-7843338] Saved searches — A saved search provides access to predefined FireSIGHT System data for users with limited permissions. When you export a custom user role that requires saved searches, the necessary saved searches are exported also. You can also export individual user-defined saved searches.
 
    	 [bookmark: pgfId-7899948] SSL policies - SSL policies include a variety of components that you can configure to determine how the system manages encrypted traffic on your network, including SSL rules and references reusable objects. Exporting an SSL policy exports all settings and components for the policy except (where present) URL reputations and categories, which are equivalent across appliances and which users cannot change. Note that to import an SSL policy, the rule update version on the exporting and importing Defense Center must match.
 
   
 
   [bookmark: pgfId-7900407]PKI objects containing private key information are encrypted with a randomly generated key when stored on the appliance. If an SSL policy you export uses PKI objects containing private keys, the private keys are decrypted before export.
 
   [bookmark: pgfId-7899917]If an SSL policy that you export contains rules that reference geolocation data, the importing Defense Center’s geolocation database (GeoDB) update version is used.
 
    
    	 [bookmark: pgfId-7871587] System policies — A system policy controls the aspects of an appliance that are likely to be similar to other FireSIGHT System appliances in your deployment, including database event limits, time settings, login banners, and so on.
 
   
 
   [bookmark: pgfId-7871594]If external authentication is enabled in the system policy you are exporting, the associated authentication objects are exported as well.
 
   [bookmark: pgfId-7871607]Note that system policies on Defense Centers contain database settings that do not apply to managed devices. If you export a system policy from a managed device and then import it onto a Defense Center, the database limits that you could not configure on the device are set to the default values on the Defense Center.
 
    
    	 [bookmark: pgfId-7843340] Third-party product mappings — If you import data from a third-party application, you must map the product to the third-party name to assign vulnerabilities and perform impact correlation using that data. Mapping the product associates Cisco vulnerability information with the third-party product name, which allows the FireSIGHT System to perform impact correlation using that data. For information on creating a third-party product mapping, see Mapping Third-Party Products.
 
    	 [bookmark: pgfId-7843341] Third-party vulnerability mappings — To add vulnerability information from a third-party application to the vulnerability database, you must map the third-party identification string for each imported vulnerability to any existing Cisco, Bugtraq, or Snort ID. After you create a mapping for the vulnerability, the mapping works for all vulnerabilities imported to hosts in your network map and allows impact correlation for those vulnerabilities. For information on creating a third-party vulnerability mapping, see Mapping Third-Party Vulnerabilities.
 
    	 [bookmark: pgfId-7865919] Application detectors — When the system analyzes IP traffic, it uses detectors to collect information about and then identify the commonly used applications running on hosts on your network. You can export two kinds of detectors: user-defined detectors and individual add-on detectors provided by Cisco Professional Services. For more information on detectors, see Working with Application Detectors.
 
   
 
    
     
   
 
   
 
   [bookmark: pgfId-7779373]Note Depending on the number of configurations being exported and the number of objects those configurations reference, the export process may take several minutes.
 
    
    
 
   
 
   
 
   [bookmark: pgfId-7889868]To export one or more configurations:
 
   [bookmark: pgfId-7889869]Access: Admin
 
   
 
   [bookmark: pgfId-7889870]Step 1 Make sure that the appliance where you are exporting the configurations and the appliance where you plan to import the configurations are running the same version of the FireSIGHT System. If you are exporting an intrusion or access control policy, make sure that the rule update versions match.
 
   [bookmark: pgfId-7791764]If the versions of the FireSIGHT System (and, if applicable, the rule update versions) do not match, the import will fail.
 
   [bookmark: pgfId-5907628]Step 2 Select Systems > Tools > Import/Export.
 
   [bookmark: pgfId-5907629]The Import/Export page appears, including a list of the configurations on the appliance. Note that configuration categories with no configurations to export do not appear in this list.
 
    
     
   
 
   
 
   
 
   [bookmark: pgfId-7822292]Step 3 Select the check boxes next to the configurations you want to export and click Export.
 
   [bookmark: pgfId-6048117]Step 4 Follow your web browser’s prompts to save the exported package to your computer.
 
   [bookmark: pgfId-7891867]
 
    
    
 
   
 
   
 
    
     [bookmark: pgfId-7811316][bookmark: 12026]Importing[bookmark: marker-7811315] Configurations
 
    [bookmark: pgfId-7811342]License: Any
 
    [bookmark: pgfId-7811318]After you export a configuration from an appliance, you can import it onto a different appliance as long as that appliance supports it. Note, however, that some imported configurations may not be useful depending on the type of appliance you are using and on your user role.
 
    [bookmark: pgfId-7754532]Depending on the type of configuration you are importing, you should keep the following points in mind:
 
     
     	 [bookmark: pgfId-7792694]You must make sure that the appliance where you import a configuration is running the same version of the FireSIGHT System as the appliance you used to export the configuration. If you are importing an intrusion or access control policy, the rule update versions on both appliances must also match. If the versions do not match, the import will fail.
 
     	 [bookmark: pgfId-7825365]When you import a custom user role that requires saved searches, the necessary saved searches are imported also.
 
     	 [bookmark: pgfId-7754269]The dashboard widgets that you can view depend on the type of appliance you are using and on your user role. For example, a dashboard created on the Defense Center and imported onto a managed device may display some invalid, disabled widgets.
 
     	 [bookmark: pgfId-7883287]If you import an access control policy that evaluates traffic based on zones, you must map the zones in the imported policy to zones on devices managed by the importing Defense Center. When you map zones, their types must match. Therefore, you must create any zone types you need on the importing Defense Center before you begin the import. For more information about security zones, see Working with Security Zones.
 
     	 [bookmark: pgfId-7883300]If you import an access control policy or saved search that includes an object or object group that has an identical name to an existing object or group, you must rename the object or group.
 
     	 [bookmark: pgfId-7887114]If you import an access control policy or an intrusion policy, the import process replaces existing default variables in the default variable set with the imported default variables. If your existing default variable set contains a custom variable not present in the imported default variable set, the unique variable is preserved. 
 
     	 [bookmark: pgfId-7754279]If you import an intrusion policy that used a shared layer from a second intrusion policy, the export process breaks the sharing relationship and the previously shared layer is copied into the package. In other words, imported intrusion policies do not contain shared layers. 
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7804937]Note You cannot use the Import/Export feature to update rules created by Cisco’s Vulnerability Research Team (VRT). Instead, download and apply the latest rule update version; see Importing Rule Updates and Local Rule Files.
 
     
     
 
    
 
    
 
     
     	 [bookmark: pgfId-7900460]If you import an SSL policy that references PKI objects that contain private keys, the system encrypts the keys with a randomly generated key before storing them on the appliance.
 
     	 [bookmark: pgfId-7900438]When you import a system policy that was exported from a Defense Center where external authentication is enabled, you also import the authentication objects on which the system policy depends.
 
    
 
    [bookmark: pgfId-7841063]Because you can export several configurations in a single package, when you import the package you must choose which configurations in the package to import. You can only import configurations that are supported on the destination appliance.
 
    [bookmark: pgfId-7883539]When you attempt to import a configuration, your appliance determines whether that configuration already exists on the appliance. If a conflict exists, you can:
 
     
     	 [bookmark: pgfId-7883589]keep the existing configuration,
 
     	 [bookmark: pgfId-7883596]replace the existing configuration with a new configuration,
 
     	 [bookmark: pgfId-7883599]keep the newest configuration, or 
 
     	 [bookmark: pgfId-7883602]import the configuration as a new configuration. 
 
    
 
    [bookmark: pgfId-7883610]If you import a configuration and then later make a modification to the configuration on the destination system, and then re-import the configuration, you must choose which version of the configuration to keep.
 
    [bookmark: pgfId-7817209]Depending on the number of configurations being imported and the number of objects those configurations reference, the import process may take several minutes.
 
    [bookmark: pgfId-7749482]To import one or more configurations:
 
    [bookmark: pgfId-6956104]Access: Admin
 
    
 
    [bookmark: pgfId-7791624]Step 1 Make sure that the appliance where you are exporting the configurations and the appliance where you plan to import the configurations are running the same version of the FireSIGHT System. If you want to import an intrusion or access control policy, you must also make sure that the rule update versions match.
 
    [bookmark: pgfId-7791631]If the versions of the FireSIGHT System (and, if applicable, the rule update versions) do not match, the import will fail.
 
    [bookmark: pgfId-6583219]Step 2 Export the configurations you want to import; see Exporting Configurations.
 
    [bookmark: pgfId-5908222]Step 3 On the appliance where you want to import the configurations, select System > Tools > Import/Export.
 
    [bookmark: pgfId-5909446]The Import/Export page appears.
 
     
      
    
 
    
 
   
 
   
 
   [bookmark: pgfId-7822930]Step 4 Click Upload Package.
 
   [bookmark: pgfId-5909462]The Upload Package page appears.
 
   [bookmark: pgfId-5909463]Step 5 You have two options:
 
    
     
     	 [bookmark: pgfId-6048429]Type the path to the package you want to upload.
 
     	 [bookmark: pgfId-6048436]Click  Browse to browse to locate the package.
 
    
 
   
 
   [bookmark: pgfId-5909469]Step 6 Click Upload. 
 
   [bookmark: pgfId-7749435]The result of the upload depends on the contents of the package:
 
    
     
     	 [bookmark: pgfId-7749446]If the configurations in the package exactly match versions that already exist on your appliance, a message displays indicating that the versions already exist. The appliance has the most recent configurations, so you do not need to import them.
 
     	 [bookmark: pgfId-7749447]If there is a FireSIGHT System or (if applicable) rule update version mismatch between your appliance and the appliance where the package was exported, a message appears, indicating that you cannot import the package. Update the FireSIGHT System or the rule update version and attempt the process again.
 
     	 [bookmark: pgfId-5909538]If the package contains any configurations or rule versions that do not exist on your appliance, the Package Import page appears. Continue with the next step.
 
    
 
   
 
   [bookmark: pgfId-5914626]Step 7 [bookmark: 57560]Select the configurations you want to import and click Import.
 
   [bookmark: pgfId-5909683]The import process resolves, with the following results: 
 
    
     
     	 [bookmark: pgfId-5914084]If the configurations you import do not have previous revisions on your appliance, the import completes automatically and a success message appears. Skip the rest of the procedure.
 
     	 [bookmark: pgfId-7847893]If you are importing an access control policy that includes security zones, the Access Control Import Resolution page appears. Continue with step  8 .
 
     	 [bookmark: pgfId-6786106]If the configurations you import do have previous revisions on your appliance, the Import Resolution page appears. Continue with step  9 .
 
    
 
   
 
   [bookmark: pgfId-7844235]Step 8 [bookmark: 76031]Next to each incoming security zone, select an existing local security zone of a matching type to map to and click Import.
 
   [bookmark: pgfId-7844410]Return to step 7.
 
   [bookmark: pgfId-7844245]Step 9 [bookmark: 29845]Expand each configuration and select the appropriate option:
 
    
     
     	 [bookmark: pgfId-7844236]To keep the configuration on your appliance, select  Keep existing .
 
     	 [bookmark: pgfId-5914114]To replace the configuration on your appliance with the imported configuration, select  Replace existing .
 
     	 [bookmark: pgfId-5914123]To keep the newest configuration, select  Keep newest .
 
     	 [bookmark: pgfId-7846540]To save the imported configuration as a new configuration, select  Import as new and, optionally, edit the configuration name.
 
    
 
   
 
   [bookmark: pgfId-7878275]If you are importing an access control policy that includes a file policy with either the clean list or custom detection list enabled, the Import as new option is not available.
 
    
     
     	 [bookmark: pgfId-7846541]If you are importing an access control policy or saved search that includes a dependent object, either accept the suggested name or rename the object. The system always imports these dependent objects as new. You do not have the option to keep or to replace existing objects. Note that the system treats objects and object groups in the same manner.
 
    
 
   
 
   [bookmark: pgfId-7844911]Step 10 Click Import.
 
   [bookmark: pgfId-5918872]The configurations are imported.
 
   [bookmark: pgfId-7891873]
 
    
    
 
   
 
   
 
   [bookmark: pgfId-7757460]
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7716759][bookmark: 94227]Purging Discovery Dat[bookmark: marker-7716758]a from the Database 
      
      
 
     
 
 
    [bookmark: pgfId-7721606]You can use the Discovery Data Purge page to purge files from the network discovery and user discovery event databases. Note that when you purge a database, the appropriate process is restarted.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-6711616] 
     Caution Purging a database removes the data you specify from the Defense Center. After the data is deleted, it 
     cannot be recovered. 
      
      
 
     
 
    
 
    [bookmark: pgfId-6711625]To purge the network and user discovery database:
 
    [bookmark: pgfId-6951202]Access: Admin/Any Security Analyst
 
    
 
    [bookmark: pgfId-6711874]Step 1 Select System > Tools > Data Purge.
 
    [bookmark: pgfId-6711881]The Data Purge page appears.
 
    [bookmark: pgfId-6711647]Step 2 Under Network Discovery, perform any or all of the following:
 
     
      
      	 [bookmark: pgfId-6711651]Select  Network Discovery Events to remove all network discovery events from the database.
 
      	 [bookmark: pgfId-6711658]Select  Hosts to remove all hosts and Indications of Compromise flags from the database.
 
      	 [bookmark: pgfId-7717817]Select  User Activity  to remove all user events from the database.
 
      	 [bookmark: pgfId-7717889]Select  User Identities to remove all user login and user history data from the database.
 
     
 
    
 
    [bookmark: pgfId-7717975]Step 3 Under Connections, perform any or all of the following:
 
     
      
      	 [bookmark: pgfId-6711662]Select  Connection Events to remove all connection data from the database.
 
      	 [bookmark: pgfId-6711666]Select  Connection Summary Events to remove all connection summary data from the database.
 
      	 [bookmark: pgfId-7718408]Select  Security Intelligence Events to remove all Security Intelligence data from the database.
 
     
 
    
 
     
      
    
 
    
 
    [bookmark: pgfId-7718409]Note Selecting Connection Events does not remove Security Intelligence events; connections with Security Intelligence data will still appear in the Security Intelligence event viewer. Correspondingly, selecting Security Intelligence Events does not remove connection events with associated Security Intelligence data.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7718410]Step 4 Click Purge Selected Events.
 
    [bookmark: pgfId-6711729]The items are purged and the appropriate processes are restarted.
 
    [bookmark: pgfId-7720036]
 
     
     
 
    
 
    
 
    [bookmark: pgfId-2514234]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7707637][bookmark: 79376]Viewing the Status of Long-Runn[bookmark: marker-5488702]ing Tasks 
      
      
 
     
 
 
    [bookmark: pgfId-7730125]Some tasks that you can perform on the FireSIGHT System, such as applying a policy or installing updates, do not complete instantly and require some time to run. You can check the progress of these long-running tasks in the task queue. The task queue also reports when they are successfully or unsuccessfully resolved.
 
    [bookmark: pgfId-7708932]For more information, see the following sections:
 
     
     	 [bookmark: pgfId-7709212]Viewing the Task Queue
 
     	 [bookmark: pgfId-7709277]Managing the Task Queue
 
    
 
   
 
    
     [bookmark: pgfId-7708951][bookmark: 37691]Viewing the Task Q[bookmark: marker-7712776]ueue
 
    [bookmark: pgfId-7722540]License: Any
 
    [bookmark: pgfId-7709557]When you perform long-running tasks, such as applying a policy or installing updates, the status of these tasks is reported in the task queue. The task queue provides information about complex tasks and reports when they are complete.
 
    [bookmark: pgfId-7722545]You view the task queue on the Task Status page, which automatically refreshes every 10 seconds. You can always see the status of tasks that you initiated. If your user account has the Administrator user role, or a user role with the View Other Users’ Tasks permission enabled, you can see the status of every task, regardless of who initiated it. For more information on configuring user roles, see Configuring User Roles.
 
    [bookmark: pgfId-7715685]The Job Summary section displays the state of the tasks listed on the page, as described in the following table.
 
    [bookmark: pgfId-7715327]
 
     
      
       
       [bookmark: pgfId-7725962]Table C-1 [bookmark: 84902]Task Queue Task Types 
 
       
       
        
        	 
          
          [bookmark: pgfId-7725966]Task Type 
         
  
        	 
          
          [bookmark: pgfId-7725968]Description 
         
  
       
 
        
        	[bookmark: pgfId-7725970]Running
  
        	[bookmark: pgfId-7725972]The number of tasks currently in progress.
  
       
 
        
        	[bookmark: pgfId-7725974]Waiting
  
        	[bookmark: pgfId-7725976]The number of tasks waiting for an in-progress task to complete before running.
  
       
 
        
        	[bookmark: pgfId-7725978]Completed
  
        	[bookmark: pgfId-7725980]The number of tasks that completed successfully.
  
       
 
        
        	[bookmark: pgfId-7725982]Retrying
  
        	[bookmark: pgfId-7725984]The number of tasks that are automatically retrying. Note that not all tasks are permitted to try again.
  
       
 
        
        	[bookmark: pgfId-7731189]Stopped
  
        	[bookmark: pgfId-7731191]The number of tasks that were interrupted due to a system update. Stopped tasks cannot be resumed; you must manually delete them from the task queue.
  
       
 
        
        	[bookmark: pgfId-7725986]Failed
  
        	[bookmark: pgfId-7725988]The number of tasks that did not complete successfully.
  
       
 
       
     
 
    
 
    [bookmark: pgfId-7725280]The Jobs section provides information about each task, including a brief description, when the task was launched, the current status of the task, and when the status last changed. Tasks of the same type, such as Network Discovery Policy Apply, appear together in a task group.
 
    [bookmark: pgfId-7715328]To make sure that the Task Status page loads quickly, once per week, the FireSIGHT System removes from the queue all completed, failed, and stopped tasks that are over a month old, as well the oldest tasks from any task group that contains over 1000 tasks. You can also manually remove tasks from the queue; see Managing the Task Queue for directions.
 
    [bookmark: pgfId-7715332]To view the task queue:
 
    [bookmark: pgfId-7722558]Access: Admin/Maint/Network Admin/Security Approver/Security Analyst
 
    
 
    [bookmark: pgfId-4761129]Step 1 You have two options:
 
     
      
      	 [bookmark: pgfId-4761130]If you manually launched the task, click the  Task Status  link in the notification box that appeared when you launched the task.
 
     
 
    
 
    [bookmark: pgfId-4761131]The Task Status page appears in a pop-up window.
 
     
      
      	 [bookmark: pgfId-4761132]If you scheduled a task, or if a task was launched from a page you are not viewing, select  System > Monitoring > Task Status .
 
     
 
    
 
    [bookmark: pgfId-4761136]The Task Status page appears.
 
    [bookmark: pgfId-7710498]For information on the actions you can perform on the Task Status page, see Managing the Task Queue.
 
    [bookmark: pgfId-7735318]
 
     
     
 
    
 
    
 
   
 
    
     [bookmark: pgfId-7708970][bookmark: 17166]Managing the Task Queu[bookmark: marker-7712781]e
 
    [bookmark: pgfId-7722578]License: Any
 
    [bookmark: pgfId-7727095]If your user account is assigned the Administrator, Maintenance User, Network Admin, Security Approver, or Security Analyst user role, there are several actions you can perform while viewing the task queue (see Viewing the Task Queue), as described in the following table.
 
    [bookmark: pgfId-7727188]
 
     
     
 
     [bookmark: pgfId-7727257]Note that you cannot delete a running task. If you need to delete a running task (for example, if a task repeatedly fails), contact Support.
 
     
 
     
 
      
       
       [bookmark: pgfId-7727203]Table C-2 Task Queue Actions 
 
       
       
        
        	 
          
          [bookmark: pgfId-7727239]To... 
         
  
        	 
          
          [bookmark: pgfId-7727241]You can... 
         
  
       
 
        
        	[bookmark: pgfId-7727243]remove all completed tasks from the task queue
  
        	[bookmark: pgfId-7727245]click Remove Completed Jobs.
  
       
 
        
        	[bookmark: pgfId-7727247]remove all failed tasks from the task queue
  
        	[bookmark: pgfId-7727249]click Remove Failed Jobs.
  
       
 
        
        	[bookmark: pgfId-7727251]remove a single task from the task queue
  ) next to the task you want to delete. 
       
 
        
        	[bookmark: pgfId-7727262]collapse a task group and hide tasks
  ) next to the expanded task group. 
       
 
        
        	[bookmark: pgfId-7727269]expand a task group and view tasks
  ) next to the collapsed task group. 
       
 
       
     
 
    
 
    [bookmark: pgfId-7727142]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7930678][bookmark: 94227]Command Li[bookmark: marker-7930677]ne Reference 
      
      
 
     
 
 
    [bookmark: pgfId-7757442]This reference explains the command line interface (CLI) for FirePOWER appliances, virtual devices, and the ASA FirePOWER modules of ASA FirePOWER devices. You can use the CLI to view, configure, and troubleshoot your FireSIGHT System.
 
     
      
    
 
    
 
    [bookmark: pgfId-7836072]Note The command line interface is not supported on Defense Centers, Series 2 appliances, Cisco NGIPS for Blue Coat X-Series, or the ASA module of ASA FirePOWER devices.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7746370]There are numerous CLI modes, such as show and configure, that contain sets of commands beginning with the mode name. You may enter a mode and then enter valid commands within that mode, or you may enter an entire full command from any mode. For example, to display information about a user account called Analyst1, you can enter the following at the CLI prompt:
 
     
     [bookmark: pgfId-7780681]show user Analyst1 
    
 
    [bookmark: pgfId-7780682]If you have previously entered show mode, enter the following at the CLI prompt:
 
     
     [bookmark: pgfId-7780683]user Analyst1 
    
 
    [bookmark: pgfId-7746358]Within each mode, the commands available to a user depend on the user’s CLI access. When you create a user account, you can assign it one of the following CLI access levels:
 
     
     	 [bookmark: pgfId-7744127]Basic
 
    
 
    [bookmark: pgfId-7744128]The user has read-only access and cannot run commands that impact system performance.
 
     
     	 [bookmark: pgfId-7744129]Configuration
 
    
 
    [bookmark: pgfId-7750746]The user has read-write access and can run commands that impact system performance.
 
     
     	 [bookmark: pgfId-7754865]None
 
    
 
    [bookmark: pgfId-7754857]The user is unable to log in to the shell.
 
    [bookmark: pgfId-7756524]On Series 3 devices, you can assign command line permissions on the User Management page in the web interface; see Managing Users for more information. On virtual devices and ASA FirePOWER devices, you assign command line permissions through the CLI itself.
 
     
      
    
 
    
 
    [bookmark: pgfId-7756572]Note If you reboot a Series 3 device and then log in to the CLI as soon as you are able, any commands you execute are not recorded in the audit log until the web interface is available.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7756575]Note that CLI commands are case-insensitive with the exception of parameters whose text is not part of the CLI framework, such as user names and search filters.
 
    [bookmark: pgfId-7770811]For information about logging into the command line, see Logging into the Appliance.
 
    [bookmark: pgfId-7740713]The following sections describe the CLI commands:
 
     
     	 [bookmark: pgfId-7740658]Basic CLI Commands
 
     	 [bookmark: pgfId-7740681]Show Commands
 
     	 [bookmark: pgfId-7740699]Configuration Commands
 
     	 [bookmark: pgfId-7775073]System Commands
 
    
 
   
 
    
     [bookmark: pgfId-7715909][bookmark: 41301]Basic CLI Commands
 
    [bookmark: pgfId-7715991]The basic CLI commands provide the ability to interact with the CLI. These commands do not affect the operation of the device. Basic commands are available to all CLI users.
 
    [bookmark: pgfId-7716628]The following sections describe the basic commands:
 
     
     	 [bookmark: pgfId-7716639]configure password
 
     	 [bookmark: pgfId-7716646]end
 
     	 [bookmark: pgfId-7716653]exit
 
     	 [bookmark: pgfId-7716660]help
 
     	 [bookmark: pgfId-7716667]history
 
     	 [bookmark: pgfId-7716674]logout
 
     	 [bookmark: pgfId-7716681]? (question mark)
 
     	 [bookmark: pgfId-7717191]?? (double question marks)
 
    
 
     
      [bookmark: pgfId-7717192][bookmark: 54561]configure password
 
     [bookmark: pgfId-7762145]Allows the current user to change their password. After issuing the command, the CLI prompts the user for their current (or old) password, then prompts the user to enter the new password twice.
 
     [bookmark: pgfId-7899681]Access
 
     [bookmark: pgfId-7729743]Basic
 
     [bookmark: pgfId-7901254]Syntax
 
      
      [bookmark: pgfId-7729767]configure password 
     
 
     [bookmark: pgfId-7903703]Example
 
      
      [bookmark: pgfId-7717248]> configure password 
     
 
      
      [bookmark: pgfId-7717258]Enter current password: 
     
 
      
      [bookmark: pgfId-7717265]Enter new password: 
     
 
      
      [bookmark: pgfId-7717272]Confirm new password: 
     
 
    
 
     
      [bookmark: pgfId-7717286][bookmark: 70378]end
 
     [bookmark: pgfId-7730791]Returns the user to the default mode. (Moves the user up to the default mode from any lower-level CLI context.)
 
     [bookmark: pgfId-7899693]Access
 
     [bookmark: pgfId-7746575]Basic
 
     [bookmark: pgfId-7901274]Syntax
 
      
      [bookmark: pgfId-7730813]end 
     
 
     [bookmark: pgfId-7903723]Example
 
      
      [bookmark: pgfId-7718267]configure network ipv4> end 
     
 
      
      [bookmark: pgfId-7753777]> 
     
 
    
 
     
      [bookmark: pgfId-7717309][bookmark: 97199]exit
 
     [bookmark: pgfId-7731140]Moves the CLI context up to the next highest CLI context level. Issuing this command from the default mode logs the user out of the current CLI session, and is equivalent to issuing the logout CLI command.
 
     [bookmark: pgfId-7899713]Access
 
     [bookmark: pgfId-7746599]Basic
 
     [bookmark: pgfId-7901286]Syntax
 
      
      [bookmark: pgfId-7731412]exit 
     
 
     [bookmark: pgfId-7903735]Example
 
      
      [bookmark: pgfId-7720703]configure network ipv4> exit 
     
 
      
      [bookmark: pgfId-7720742]configure network> 
     
 
    
 
     
      [bookmark: pgfId-7752871][bookmark: 93089]help
 
     [bookmark: pgfId-7752872]Displays an overview of the CLI syntax.
 
     [bookmark: pgfId-7899733]Access
 
     [bookmark: pgfId-7752876]Basic
 
     [bookmark: pgfId-7901298]Syntax
 
      
      [bookmark: pgfId-7752878]help 
     
 
     [bookmark: pgfId-7903747]Example
 
      
      [bookmark: pgfId-7752880]> help 
     
 
    
 
     
      [bookmark: pgfId-7752859][bookmark: 31640]history
 
     [bookmark: pgfId-7730040]Displays the command line history for the current session.
 
     [bookmark: pgfId-7899753]Access
 
     [bookmark: pgfId-7746679]Basic
 
     [bookmark: pgfId-7901310]Syntax
 
      
      [bookmark: pgfId-7730110]history limit 
     
 
     [bookmark: pgfId-7730050]where limit sets the size of the history list. To set the size to unlimited, enter zero.
 
     [bookmark: pgfId-7903759]Example
 
      
      [bookmark: pgfId-7730141]history 25 
     
 
    
 
     
      [bookmark: pgfId-7719284][bookmark: 74638]logout
 
     [bookmark: pgfId-7731996]Logs the current user out of the current CLI console session.
 
     [bookmark: pgfId-7899773]Access
 
     [bookmark: pgfId-7746724]Basic
 
     [bookmark: pgfId-7901322]Syntax
 
      
      [bookmark: pgfId-7731926]logout 
     
 
     [bookmark: pgfId-7903855]Example
 
      
      [bookmark: pgfId-7731971]> logout 
     
 
    
 
     
      [bookmark: pgfId-7719311][bookmark: 61604]? (question mark)
 
     [bookmark: pgfId-7740071]Displays context-sensitive help for CLI commands and parameters. Use the question mark (?) command as follows:
 
      
      	 [bookmark: pgfId-7732232]To display help for the commands that are available within the current CLI context, enter a question mark ( ? ) at the command prompt.
 
      	 [bookmark: pgfId-7732233]To display a list of the available commands that start with a particular character set, enter the abbreviated command immediately followed by a question mark ( ? ).
 
      	 [bookmark: pgfId-7732234]To display help for a command’s legal arguments, enter a question mark ( ? ) in place of an argument at the command prompt.
 
     
 
     [bookmark: pgfId-7719312]Note that the question mark (?) is not echoed back to the console.
 
     [bookmark: pgfId-7899789]Access
 
     [bookmark: pgfId-7746778]Basic
 
     [bookmark: pgfId-7901334]Syntax
 
      
      [bookmark: pgfId-7732072]? 
     
 
      
      [bookmark: pgfId-7732073]abbreviated_command ? 
     
 
      
      [bookmark: pgfId-7732045]command [arguments] ? 
     
 
     [bookmark: pgfId-7903875]Example
 
      
      [bookmark: pgfId-7721346]> ? 
     
 
    
 
     
      [bookmark: pgfId-7719361][bookmark: 66724]?? (double question marks)
 
     [bookmark: pgfId-7732582]Displays detailed context-sensitive help for CLI commands and parameters.
 
     [bookmark: pgfId-7899805]Access
 
     [bookmark: pgfId-7746798]Basic
 
     [bookmark: pgfId-7901346]Syntax
 
      
      [bookmark: pgfId-7732327]?? 
     
 
      
      [bookmark: pgfId-7732328]abbreviated_command end?? 
     
 
      
      [bookmark: pgfId-7732310]command [arguments] ?? 
     
 
     [bookmark: pgfId-7903891]Example
 
      
      [bookmark: pgfId-7721370]> configure manager add ?? 
     
 
    
 
   
 
    
     [bookmark: pgfId-7717316][bookmark: 45340]Show Commands
 
    [bookmark: pgfId-7717418]Show commands provide information about the state of the device. These commands do not change the operational mode of the device and running them has minimal impact on system operation. Most show commands are available to all CLI users; however, only users with configuration CLI access can issue the show user command.
 
    [bookmark: pgfId-7717473]The following sections describe the show commands:
 
     
     	 [bookmark: pgfId-7717486]access-control-config
 
     	 [bookmark: pgfId-7764516]alarms
 
     	 [bookmark: pgfId-7782618]arp-tables
 
     	 [bookmark: pgfId-7764694]audit-log
 
     	 [bookmark: pgfId-7855343]bypass
 
     	 [bookmark: pgfId-7717496]clustering
 
     	 [bookmark: pgfId-7717503]cpu
 
     	 [bookmark: pgfId-7777990]database
 
     	 [bookmark: pgfId-7772166]device-settings
 
     	 [bookmark: pgfId-7717517]disk
 
     	 [bookmark: pgfId-7854888]disk-manager
 
     	 [bookmark: pgfId-7717524]dns
 
     	 [bookmark: pgfId-7849104]expert
 
     	 [bookmark: pgfId-7849112]fan-status
 
     	 [bookmark: pgfId-7765006]fastpath-rules
 
     	 [bookmark: pgfId-7717538]gui
 
     	 [bookmark: pgfId-7717545]hostname
 
     	 [bookmark: pgfId-7952680]hosts
 
     	 [bookmark: pgfId-7952684]hyperthreading
 
     	 [bookmark: pgfId-7952705]iab
 
     	 [bookmark: pgfId-7952688]ifconfig
 
     	 [bookmark: pgfId-7767625]inline-sets
 
     	 [bookmark: pgfId-7717562]interfaces
 
     	 [bookmark: pgfId-7748747]lcd
 
     	 [bookmark: pgfId-7718805]link-state
 
     	 [bookmark: pgfId-7823670]log-ips-connection
 
     	 [bookmark: pgfId-7718824]managers
 
     	 [bookmark: pgfId-7718843]memory
 
     	 [bookmark: pgfId-7718862]model
 
     	 [bookmark: pgfId-7765112]mpls-depth
 
     	 [bookmark: pgfId-7765562]NAT
 
     	 [bookmark: pgfId-7870194]netstat
 
     	 [bookmark: pgfId-7718881]network
 
     	 [bookmark: pgfId-7940068]network-modules
 
     	 [bookmark: pgfId-7940069]network-static-routes
 
     	 [bookmark: pgfId-7940073]ntp
 
     	 [bookmark: pgfId-7940077]perfstats
 
     	 [bookmark: pgfId-7718925]portstats
 
     	 [bookmark: pgfId-7765665]power-supply-status
 
     	 [bookmark: pgfId-7772188]process-tree
 
     	 [bookmark: pgfId-7718936]processes
 
     	 [bookmark: pgfId-7870088]route
 
     	 [bookmark: pgfId-7718959]routing-table
 
     	 [bookmark: pgfId-7766542]serial-number
 
     	 [bookmark: pgfId-7922212]ssl-policy-config
 
     	 [bookmark: pgfId-7799466]stacking
 
     	 [bookmark: pgfId-7718970]summary
 
     	 [bookmark: pgfId-7718981]time
 
     	 [bookmark: pgfId-7766516]traffic-statistics
 
     	 [bookmark: pgfId-7797494]user
 
     	 [bookmark: pgfId-7797498]users
 
     	 [bookmark: pgfId-7718992]version
 
     	 [bookmark: pgfId-7766812]virtual-routers
 
     	 [bookmark: pgfId-7799506]virtual-switches
 
     	 [bookmark: pgfId-7922220]vmware-tools
 
    
 
     
      [bookmark: pgfId-7799508][bookmark: 25597]access-control-config
 
     [bookmark: pgfId-7926517]Displays the currently applied access control configurations, including: Security Intelligence settings; the name of referenced SSL, network analysis, intrusion, and file policies; intrusion variable set data; logging settings; and other advanced settings, including policy-level performance, preprocessing, and general settings.
 
     [bookmark: pgfId-7926717]Also displays policy-related connection information, such as source and destination port data (including type and code for ICMP entries) and the number of connections that matched each access control rule (hit counts).
 
     [bookmark: pgfId-7899821]Access
 
     [bookmark: pgfId-7764399]Basic
 
     [bookmark: pgfId-7901358]Syntax
 
      
      [bookmark: pgfId-7764401]show access-control-config 
     
 
     [bookmark: pgfId-7903903]Example
 
      
      [bookmark: pgfId-7764403]> show access-control-config 
     
 
    
 
     
      [bookmark: pgfId-7764253][bookmark: 90698]alarms
 
     [bookmark: pgfId-7871962]Displays currently active (failed/down) hardware alarms on the device. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7899841]Access
 
     [bookmark: pgfId-7746837]Basic
 
     [bookmark: pgfId-7901370]Syntax
 
      
      [bookmark: pgfId-7732816]show alarms 
     
 
     [bookmark: pgfId-7903919]Example
 
      
      [bookmark: pgfId-7733003]> show alarms 
     
 
    
 
     
      [bookmark: pgfId-7782494][bookmark: 84598]arp-tables
 
     [bookmark: pgfId-7871985]Displays the Address Resolution Protocol tables applicable to your network. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7899853]Access
 
     [bookmark: pgfId-7782497]Basic
 
     [bookmark: pgfId-7901382]Syntax
 
      
      [bookmark: pgfId-7782499]show arp-tables 
     
 
     [bookmark: pgfId-7903934]Example
 
      
      [bookmark: pgfId-7782501]> show arp-tables 
     
 
    
 
     
      [bookmark: pgfId-7764626][bookmark: 44980]audit-log
 
     [bookmark: pgfId-7764627]Displays the audit log in reverse chronological order; the most recent audit log events are listed first.
 
     [bookmark: pgfId-7899865]Access
 
     [bookmark: pgfId-7764629]Basic
 
     [bookmark: pgfId-7901477]Syntax
 
      
      [bookmark: pgfId-7764631]show audit-log 
     
 
     [bookmark: pgfId-7903946]Example
 
      
      [bookmark: pgfId-7764633]> show audit-log 
     
 
    
 
     
      [bookmark: pgfId-7855226][bookmark: 84379]bypass
 
     [bookmark: pgfId-7855227]On Series 3 devices, lists the inline sets in use and shows the bypass mode status of those sets as one of the following:
 
      
      	 [bookmark: pgfId-7947712] armed —the interface pair is configured to go into hardware bypass if it fails, or has been forced into fail-close with the  configure bypass close  command
 
      	 [bookmark: pgfId-7947822] engaged —the interface pair has failed open or has been forced into hardware bypass with the  configure bypass open command
 
      	 [bookmark: pgfId-7947926] off —the interface pair is set to fail-close ( Bypass Mode: Non-Bypass ); packets are blocked if the interface pair fails
 
     
 
     [bookmark: pgfId-7899877]Access
 
     [bookmark: pgfId-7855229]Basic
 
     [bookmark: pgfId-7901497]Syntax
 
      
      [bookmark: pgfId-7855231]show bypass 
     
 
     [bookmark: pgfId-7903970]Example
 
      
      [bookmark: pgfId-7855233]> show bypass 
     
 
      
      [bookmark: pgfId-7948085]s1p1 <-> s1p2: status ‘armed’ 
     
 
      
      [bookmark: pgfId-7948137]s1p1 <-> s1p2: status ‘engaged’ 
     
 
      
      [bookmark: pgfId-7948129] 
     
 
    
 
     
      [bookmark: pgfId-7947444][bookmark: 90542]clustering
 
     [bookmark: pgfId-7947445]Displays information about device clustering configuration, status, and member stacks. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7899889]Access
 
     [bookmark: pgfId-7764733]Basic
 
    
 
     
      [bookmark: pgfId-7849836]config
 
     [bookmark: pgfId-7849913]Displays the clustering configuration on the device.
 
     [bookmark: pgfId-7901509]Syntax
 
      
      [bookmark: pgfId-7764735]show clustering config 
     
 
     [bookmark: pgfId-7903982]Example
 
      
      [bookmark: pgfId-7764737]> show clustering config 
     
 
    
 
     
      [bookmark: pgfId-7849616]clustering ha-statistics
 
     [bookmark: pgfId-7849617]Displays state sharing statistics for a device in a cluster.
 
     [bookmark: pgfId-7901521]Syntax
 
      
      [bookmark: pgfId-7849621]show clustering ha-statistics 
     
 
     [bookmark: pgfId-7903994]Example
 
      
      [bookmark: pgfId-7849623]> show clustering ha-statistics 
     
 
    
 
     
      [bookmark: pgfId-7719427][bookmark: 96097]cpu
 
     [bookmark: pgfId-7733188]Displays the current CPU usage statistics appropriate for the platform for all CPUs on the device. For managed devices, the following values are displayed:
 
      
      	 [bookmark: pgfId-7750569]CPU
 
     
 
     [bookmark: pgfId-7750155]Processor number.
 
      
      	 [bookmark: pgfId-7750375]Load
 
     
 
     [bookmark: pgfId-7750382]The CPU utilization, represented as a number from 0 to 100. 0 is not loaded and 100 is completely loaded.
 
     [bookmark: pgfId-7797513]For virtual devices and ASA FirePOWER devices, the following values are displayed: 
 
      
      	 [bookmark: pgfId-7797514]CPU
 
     
 
     [bookmark: pgfId-7797515]Processor number.
 
      
      	 [bookmark: pgfId-7797516]%user
 
     
 
     [bookmark: pgfId-7797517]Percentage of CPU utilization that occurred while executing at the user level (application).
 
      
      	 [bookmark: pgfId-7797518]%nice
 
     
 
     [bookmark: pgfId-7797519]Percentage of CPU utilization that occurred while executing at the user level with nice priority.
 
      
      	 [bookmark: pgfId-7797520]%sys
 
     
 
     [bookmark: pgfId-7797521]Percentage of CPU utilization that occurred while executing at the system level (kernel). This does not include time spent servicing interrupts or softirqs. A softirq (software interrupt) is one of up to 32 enumerated software interrupts that can run on multiple CPUs at once.
 
      
      	 [bookmark: pgfId-7797522]%iowait
 
     
 
     [bookmark: pgfId-7797523]Percentage of time that the CPUs were idle when the system had an outstanding disk I/O request.
 
      
      	 [bookmark: pgfId-7797524]%irq
 
     
 
     [bookmark: pgfId-7797525]Percentage of time spent by the CPUs to service interrupts.
 
      
      	 [bookmark: pgfId-7797526]%soft
 
     
 
     [bookmark: pgfId-7797527]Percentage of time spent by the CPUs to service softirqs. 
 
      
      	 [bookmark: pgfId-7797528]%steal
 
     
 
     [bookmark: pgfId-7797529]Percentage of time spent in involuntary wait by the virtual CPUs while the hypervisor was servicing another virtual processor.
 
      
      	 [bookmark: pgfId-7797530]%guest
 
     
 
     [bookmark: pgfId-7797531]Percentage of time spent by the CPUs to run a virtual processor.
 
      
      	 [bookmark: pgfId-7797532]%idle
 
     
 
     [bookmark: pgfId-7797533]Percentage of time that the CPUs were idle and the system did not have an outstanding disk I/O request.
 
     [bookmark: pgfId-7899913]Access
 
     [bookmark: pgfId-7746911]Basic
 
     [bookmark: pgfId-7901533]Syntax
 
      
      [bookmark: pgfId-7733165]show cpu [procnum] 
     
 
     [bookmark: pgfId-7749948]where procnum is the number of the processor for which you want the utilization information displayed. Valid values are 0 to one less than the total number of processors on the system. If procnum is used for a managed device, it is ignored because for that platform, utilization information can only be displayed for all processors.
 
     [bookmark: pgfId-7904006]Example
 
      
      [bookmark: pgfId-7719432]> show cpu 
     
 
    
 
     
      [bookmark: pgfId-7772350][bookmark: 57732]database
 
     [bookmark: pgfId-7772434]The show database commands configure the device’s management interface.
 
     [bookmark: pgfId-7899925]Access
 
     [bookmark: pgfId-7772436]Basic
 
    
 
     
      [bookmark: pgfId-7772437]processes
 
     [bookmark: pgfId-7772438]Displays a list of running database queries.
 
     [bookmark: pgfId-7899937]Access
 
     [bookmark: pgfId-7772353]Basic
 
     [bookmark: pgfId-7901549]Syntax
 
      
      [bookmark: pgfId-7772355]show database processes 
     
 
     [bookmark: pgfId-7904018]Example
 
      
      [bookmark: pgfId-7772357]> show database processes 
     
 
    
 
     
      [bookmark: pgfId-7772530]slow-query-log
 
     [bookmark: pgfId-7772531]Displays the slow query log of the database.
 
     [bookmark: pgfId-7899949]Access
 
     [bookmark: pgfId-7772534]Basic
 
     [bookmark: pgfId-7901561]Syntax
 
      
      [bookmark: pgfId-7772536]show database slow-query-log 
     
 
     [bookmark: pgfId-7904085]Example
 
      
      [bookmark: pgfId-7772538]> show database slow-query-log 
     
 
    
 
     
      [bookmark: pgfId-7763676][bookmark: 10406]device-settings
 
     [bookmark: pgfId-7763742]Displays information about application bypass settings specific to the current device.
 
     [bookmark: pgfId-7899961]Access
 
     [bookmark: pgfId-7763946]Basic
 
     [bookmark: pgfId-7901573]Syntax
 
      
      [bookmark: pgfId-7764072]show device-settings 
     
 
     [bookmark: pgfId-7904105]Example
 
      
      [bookmark: pgfId-7764114]> show device-settings 
     
 
    
 
     
      [bookmark: pgfId-7764116][bookmark: 51891]disk
 
     [bookmark: pgfId-7764117]Displays the current disk usage.
 
     [bookmark: pgfId-7899973]Access
 
     [bookmark: pgfId-7746999]Basic
 
     [bookmark: pgfId-7901585]Syntax
 
      
      [bookmark: pgfId-7733598]show disk 
     
 
     [bookmark: pgfId-7904182]Example
 
      
      [bookmark: pgfId-7726778]> show disk 
     
 
    
 
     
      [bookmark: pgfId-7854698][bookmark: 44001]disk-manager
 
     [bookmark: pgfId-7854699]Displays detailed disk usage information for each part of the system, including silos, low watermarks, and high watermarks.
 
     [bookmark: pgfId-7899985]Access
 
     [bookmark: pgfId-7854701]Basic
 
     [bookmark: pgfId-7901605]Syntax
 
      
      [bookmark: pgfId-7854703]show disk-manager 
     
 
     [bookmark: pgfId-7904194]Example
 
      
      [bookmark: pgfId-7854705]> show disk-manager 
     
 
    
 
     
      [bookmark: pgfId-7719568][bookmark: 31339]dns
 
     [bookmark: pgfId-7733697]Displays the current DNS server addresses and search domains. 
 
     [bookmark: pgfId-7900005]Access
 
     [bookmark: pgfId-7747043]Basic
 
     [bookmark: pgfId-7901625]Syntax
 
      
      [bookmark: pgfId-7733719]show dns 
     
 
     [bookmark: pgfId-7904206]Example
 
      
      [bookmark: pgfId-7726804]> show dns 
     
 
    
 
     
      [bookmark: pgfId-7772676][bookmark: 23792]expert
 
     [bookmark: pgfId-7772677]Invokes the shell. 
 
     [bookmark: pgfId-7900025]Access
 
     [bookmark: pgfId-7772679]Basic
 
     [bookmark: pgfId-7901645]Syntax
 
      
      [bookmark: pgfId-7772681]expert 
     
 
     [bookmark: pgfId-7904226]Example
 
      
      [bookmark: pgfId-7772683]> expert 
     
 
    
 
     
      [bookmark: pgfId-7764841][bookmark: 99332]fan-status
 
     [bookmark: pgfId-7764842]Displays the current status of hardware fans. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900045]Access
 
     [bookmark: pgfId-7764844]Basic
 
     [bookmark: pgfId-7901661]Syntax
 
      
      [bookmark: pgfId-7764846]show fan-status 
     
 
     [bookmark: pgfId-7904246]Example
 
      
      [bookmark: pgfId-7764824]> show fan-status 
     
 
    
 
     
      [bookmark: pgfId-7764932][bookmark: 15847]fastpath-rules
 
     [bookmark: pgfId-7764933]Displays the currently configured fastpath rules. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900065]Access
 
     [bookmark: pgfId-7764935]Basic
 
     [bookmark: pgfId-7901673]Syntax
 
      
      [bookmark: pgfId-7764937]show fastpath-rules 
     
 
     [bookmark: pgfId-7904262]Example
 
      
      [bookmark: pgfId-7764939]> show fastpath-rules 
     
 
    
 
     
      [bookmark: pgfId-7719622][bookmark: 59579]gui
 
     [bookmark: pgfId-7733924]Displays the current state of the web interface. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900077]Access
 
     [bookmark: pgfId-7747112]Basic
 
     [bookmark: pgfId-7901685]Syntax
 
      
      [bookmark: pgfId-7733957]show gui 
     
 
     [bookmark: pgfId-7904278]Example
 
      
      [bookmark: pgfId-7727716]> show gui 
     
 
    
 
     
      [bookmark: pgfId-7719660][bookmark: 46314]hostname
 
     [bookmark: pgfId-7734101]Displays the device’s host name and appliance UUID. If you edit the host name of a device using the CLI, confirm that the changes are reflected on the managing Defense Center. In some cases, you may need to edit the device management settings manually. For more information, see Editing Device Management Settings.
 
     [bookmark: pgfId-7900089]Access
 
     [bookmark: pgfId-7747166]Basic
 
     [bookmark: pgfId-7901697]Syntax
 
      
      [bookmark: pgfId-7734087]show hostname 
     
 
     [bookmark: pgfId-7904290]Example
 
      
      [bookmark: pgfId-7727746]> show hostname 
     
 
    
 
     
      [bookmark: pgfId-7867987][bookmark: 18172]hosts
 
     [bookmark: pgfId-7868107]Displays the contents of an ASA FirePOWER module’s /etc/hosts file.
 
     [bookmark: pgfId-7900101]Access
 
     [bookmark: pgfId-7868109]Basic
 
     [bookmark: pgfId-7901709]Syntax
 
      
      [bookmark: pgfId-7868111]show hosts 
     
 
     [bookmark: pgfId-7904302]Example
 
      
      [bookmark: pgfId-7868030]> show hosts 
     
 
    
 
     
      [bookmark: pgfId-7822507][bookmark: 43208]hyperthreading
 
     [bookmark: pgfId-7822508]Displays whether hyperthreading is enabled or disabled. This command is not available on ASA FirePOWER devices.
 
     [bookmark: pgfId-7900113]Access
 
     [bookmark: pgfId-7822510]Basic
 
     [bookmark: pgfId-7901721]Syntax
 
      
      [bookmark: pgfId-7822512]show hyperthreading 
     
 
     [bookmark: pgfId-7904314]Example
 
      
      [bookmark: pgfId-7822514]> show hyperthreading 
     
 
    
 
     
      [bookmark: pgfId-7952442][bookmark: 20609]iab
 
     [bookmark: pgfId-7952864]Displays the current Intelligent Application Bypass (IAB) configuration. This command requires Version 5.4.0.10 or later on the managed device. The Defense Center requires Version 5.4.1.9 or later to implement IAB functionality, and Version 5.4.1.10 or later to provide IAB events.
 
     [bookmark: pgfId-7952545]Access
 
     [bookmark: pgfId-7952546]Basic
 
     [bookmark: pgfId-7952547]Syntax
 
      
      [bookmark: pgfId-7952548]show iab 
     
 
     [bookmark: pgfId-7952549]Example
 
      
      [bookmark: pgfId-7952550]> show iab 
     
 
      
      [bookmark: pgfId-7972636]IAB configuration: 
     
 
      
      [bookmark: pgfId-7972732]Performance Sample Interval 5 seconds 
     
 
      
      [bookmark: pgfId-7972733]Bytes per Flow 500000 kbytes 
     
 
      
      [bookmark: pgfId-7972734]Flow Velocity 25000 kbytes/second 
     
 
      
      [bookmark: pgfId-7972735]Drop Percentage 1% 
     
 
      
      [bookmark: pgfId-7972736]Processor Utilization Percentage 95% 
     
 
      
      [bookmark: pgfId-7960571]Packet Latency 250 microseconds 
     
 
    
 
     
      [bookmark: pgfId-7767542][bookmark: 14522]inline-sets
 
     [bookmark: pgfId-7767543]Displays configuration data for all inline security zones and associated interfaces. This command is not available on ASA FirePOWER devices.
 
     [bookmark: pgfId-7900125]Access
 
     [bookmark: pgfId-7767545]Basic
 
     [bookmark: pgfId-7901793]Syntax
 
      
      [bookmark: pgfId-7767547]show inline-sets 
     
 
     [bookmark: pgfId-7904330]Example
 
      
      [bookmark: pgfId-7767549]> show inline-sets 
     
 
    
 
     
      [bookmark: pgfId-7719780][bookmark: 10786]interfaces
 
     [bookmark: pgfId-7734280]If no parameters are specified, displays a list of all configured interfaces. If a parameter is specified, displays detailed information about the specified interface.
 
     [bookmark: pgfId-7900137]Access
 
     [bookmark: pgfId-7747232]Basic
 
     [bookmark: pgfId-7901813]Syntax
 
      
      [bookmark: pgfId-7734266]show interfaces [interface] 
     
 
     [bookmark: pgfId-7740806]where interface is the specific interface for which you want the detailed information.
 
     [bookmark: pgfId-7904346]Example
 
      
      [bookmark: pgfId-7727866]> show interfaces 
     
 
    
 
     
      [bookmark: pgfId-7868384][bookmark: 11638]ifconfig
 
     [bookmark: pgfId-7868385]Displays the interface configuration for an ASA FirePOWER module.
 
     [bookmark: pgfId-7900157]Access
 
     [bookmark: pgfId-7868387]Basic
 
     [bookmark: pgfId-7901825]Syntax
 
      
      [bookmark: pgfId-7868389]show ifconfig 
     
 
     [bookmark: pgfId-7904362]Example
 
      
      [bookmark: pgfId-7868391]> show ifconfig 
     
 
    
 
     
      [bookmark: pgfId-7872210][bookmark: 39679]lcd
 
     [bookmark: pgfId-7872211]Displays whether the LCD hardware display is enabled or disabled. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900177]Access
 
     [bookmark: pgfId-7748807]Basic
 
     [bookmark: pgfId-7901845]Syntax
 
      
      [bookmark: pgfId-7748809]show lcd 
     
 
     [bookmark: pgfId-7904378]Example
 
      
      [bookmark: pgfId-7748811]> show lcd 
     
 
    
 
     
      [bookmark: pgfId-7927512]link-aggregation
 
     [bookmark: pgfId-7928837]The show link-aggregation commands display configuration and statistics information for link aggregation groups (LAGs). This command is not available on virtual devices and ASA FirePOWER devices. 
 
     [bookmark: pgfId-7927688]Access
 
     [bookmark: pgfId-7927689]Basic
 
    
 
     
      [bookmark: pgfId-7927520]configuration
 
     [bookmark: pgfId-7927521]Displays configuration details for each configured LAG, including LAG ID, number of interfaces, configuration mode, load-balancing mode, LACP information, and physical interface type.
 
     [bookmark: pgfId-7927540]Access
 
     [bookmark: pgfId-7927541]Basic
 
     [bookmark: pgfId-7927542]Syntax
 
      
      [bookmark: pgfId-7927543]show link-aggregation configuration 
     
 
     [bookmark: pgfId-7927544]Example
 
      
      [bookmark: pgfId-7927545]> show link-aggregation configuration 
     
 
    
 
     
      [bookmark: pgfId-7927546]statistics
 
     [bookmark: pgfId-7927547]Displays statistics, per interface, for each configured LAG, including status, link state and speed, configuration mode, counters for received and transmitted packets, and counters for received and transmitted bytes. 
 
     [bookmark: pgfId-7927549]Access
 
     [bookmark: pgfId-7927550]Basic
 
     [bookmark: pgfId-7927551]Syntax
 
      
      [bookmark: pgfId-7927552]show link-aggregation statistics 
     
 
     [bookmark: pgfId-7927553]Example
 
      
      [bookmark: pgfId-7927554]> show link-aggregation statistics 
     
 
    
 
     
      [bookmark: pgfId-7748762][bookmark: 37432]link-state
 
     [bookmark: pgfId-7742316]Displays type, link, speed, duplex state, and bypass mode of the ports on the device. This command is not available on ASA FirePOWER devices.
 
     [bookmark: pgfId-7900197]Access
 
     [bookmark: pgfId-7747304]Basic
 
     [bookmark: pgfId-7901857]Syntax
 
      
      [bookmark: pgfId-7734540]show link-state 
     
 
     [bookmark: pgfId-7904390]Example
 
      
      [bookmark: pgfId-7727055]> show link-state 
     
 
    
 
     
      [bookmark: pgfId-7823689][bookmark: 11349]log-ips-connection
 
     [bookmark: pgfId-7823690]Displays whether the logging of connection events that are associated with logged intrusion events is enabled or disabled.
 
     [bookmark: pgfId-7900213]Access
 
     [bookmark: pgfId-7823692]Basic
 
     [bookmark: pgfId-7901877]Syntax
 
      
      [bookmark: pgfId-7823694]show log-ips-connection 
     
 
     [bookmark: pgfId-7904451]Example
 
      
      [bookmark: pgfId-7823696]> show log-ips-connection 
     
 
    
 
     
      [bookmark: pgfId-7719872][bookmark: 45886]managers
 
     [bookmark: pgfId-7770736]Displays the configuration and communication status of the Defense Center. Registration key and NAT ID are only displayed if registration is pending. If a device is registered to a high availability pair, information about both managing Defense Centers is displayed. If a device is configured as a secondary device in a stacked configuration, information about both the managing Defense Center and the primary device is displayed.
 
     [bookmark: pgfId-7900229]Access
 
     [bookmark: pgfId-7747341]Basic
 
     [bookmark: pgfId-7901893]Syntax
 
      
      [bookmark: pgfId-7734687]show managers 
     
 
     [bookmark: pgfId-7904471]Example
 
      
      [bookmark: pgfId-7727070]> show managers 
     
 
    
 
     
      [bookmark: pgfId-7719897][bookmark: 23529]memory
 
     [bookmark: pgfId-7741137]Displays the total memory, the memory in use, and the available memory for the device.
 
     [bookmark: pgfId-7900241]Access
 
     [bookmark: pgfId-7747379]Basic
 
     [bookmark: pgfId-7901909]Syntax
 
      
      [bookmark: pgfId-7734956]show memory 
     
 
     [bookmark: pgfId-7904483]Example
 
      
      [bookmark: pgfId-7727085]> show memory 
     
 
    
 
     
      [bookmark: pgfId-7719922][bookmark: 29666]model
 
     [bookmark: pgfId-7735098]Displays model information for the device.
 
     [bookmark: pgfId-7900257]Access
 
     [bookmark: pgfId-7747407]Basic
 
     [bookmark: pgfId-7901925]Syntax
 
      
      [bookmark: pgfId-7735032]show model 
     
 
     [bookmark: pgfId-7904495]Example
 
      
      [bookmark: pgfId-7765078]> show model 
     
 
    
 
     
      [bookmark: pgfId-7765079][bookmark: 63542]mpls-depth
 
     [bookmark: pgfId-7765080]Displays the number of MPLS layers configured on the management interface, from 0 to 6. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900269]Access
 
     [bookmark: pgfId-7765048]Basic
 
     [bookmark: pgfId-7901949]Syntax
 
      
      [bookmark: pgfId-7765050]show mpls-depth 
     
 
     [bookmark: pgfId-7904507]Example
 
      
      [bookmark: pgfId-7831387]> show mpls-depth 
     
 
    
 
     
      [bookmark: pgfId-7831465][bookmark: 49914]NAT
 
     [bookmark: pgfId-7833110]The show nat commands display NAT data and configuration information for the management interface. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900285]Access
 
     [bookmark: pgfId-7831517]Basic
 
    
 
     
      [bookmark: pgfId-7831875]active-dynamic
 
     [bookmark: pgfId-7831876]Displays NAT flows translated according to dynamic rules. These entries are displayed when a flow matches a rule, and persist until the rule has timed out. Therefore, the list can be inaccurate. Timeouts are protocol dependent: ICMP is 5 seconds, UDP is 120 seconds, TCP is 3600 seconds, and all other protocols are 60 seconds.
 
     [bookmark: pgfId-7901961]Syntax
 
      
      [bookmark: pgfId-7831878]show nat active-dynamic 
     
 
     [bookmark: pgfId-7904527]Example
 
      
      [bookmark: pgfId-7831880]> show nat active-dynamic 
     
 
    
 
     
      [bookmark: pgfId-7831985]active-static
 
     [bookmark: pgfId-7831986]Displays NAT flows translated according to static rules. These entries are displayed as soon as you apply the rule to the device, and the list does not indicate active flows that match a static NAT rule.
 
     [bookmark: pgfId-7901973]Syntax
 
      
      [bookmark: pgfId-7831988]show nat active-static 
     
 
     [bookmark: pgfId-7904547]Example
 
      
      [bookmark: pgfId-7831990]> show nat active-static 
     
 
    
 
     
      [bookmark: pgfId-7832285]allocators
 
     [bookmark: pgfId-7832286]Displays information for all NAT allocators, the pool of translated addresses used by dynamic rules.
 
     [bookmark: pgfId-7901985]Syntax
 
      
      [bookmark: pgfId-7832288]show nat allocators 
     
 
     [bookmark: pgfId-7904563]Example
 
      
      [bookmark: pgfId-7832290]> show nat allocators 
     
 
    
 
     
      [bookmark: pgfId-7831871]config
 
     [bookmark: pgfId-7831643]Displays the current NAT policy configuration for the management interface.
 
     [bookmark: pgfId-7901997]Syntax
 
      
      [bookmark: pgfId-7831645]show nat config 
     
 
     [bookmark: pgfId-7904579]Example
 
      
      [bookmark: pgfId-7831647]> show nat config 
     
 
    
 
     
      [bookmark: pgfId-7832448]dynamic-rules
 
     [bookmark: pgfId-7832449]Displays dynamic NAT rules that use the specified allocator ID.
 
     [bookmark: pgfId-7902009]Syntax
 
      
      [bookmark: pgfId-7833804]show nat dynamic-rules allocator_id 
     
 
     [bookmark: pgfId-7904601]Example
 
      
      [bookmark: pgfId-7832453]> show nat dynamic-rules 9 
     
 
     [bookmark: pgfId-7832454]where allocator_id is a valid allocator ID number.
 
    
 
     
      [bookmark: pgfId-7832538]flows
 
     [bookmark: pgfId-7832539]Displays the number of flows for rules that use the specified allocator ID.
 
     [bookmark: pgfId-7902025]Syntax
 
      
      [bookmark: pgfId-7832541]show nat flows allocator-id 
     
 
     [bookmark: pgfId-7904613]Example
 
      
      [bookmark: pgfId-7832543]> show nat flows 81 
     
 
     [bookmark: pgfId-7832544]where allocator_id is a valid allocator ID number.
 
    
 
     
      [bookmark: pgfId-7832769]static-rules
 
     [bookmark: pgfId-7832770]Displays all static NAT rules.
 
     [bookmark: pgfId-7902037]Syntax
 
      
      [bookmark: pgfId-7832772]show nat static-rules 
     
 
     [bookmark: pgfId-7904625]Example
 
      
      [bookmark: pgfId-7832774]> show nat static-rules 
     
 
    
 
     
      [bookmark: pgfId-7868544][bookmark: 75784]netstat
 
     [bookmark: pgfId-7868545]Displays the active network connections for an ASA FirePOWER module.
 
     [bookmark: pgfId-7900307]Access
 
     [bookmark: pgfId-7868547]Basic
 
     [bookmark: pgfId-7902053]Syntax
 
      
      [bookmark: pgfId-7868549]show netstat 
     
 
     [bookmark: pgfId-7904637]Example
 
      
      [bookmark: pgfId-7868551]> show netstat 
     
 
    
 
     
      [bookmark: pgfId-7765424][bookmark: 33242]network
 
     [bookmark: pgfId-7765425]Displays the IPv4 and IPv6 configuration of the management interface, its MAC address, and HTTP proxy address, port, and username if configured.
 
     [bookmark: pgfId-7900376]Access
 
     [bookmark: pgfId-7747456]Basic
 
     [bookmark: pgfId-7902065]Syntax
 
      
      [bookmark: pgfId-7735147]show network 
     
 
     [bookmark: pgfId-7904698]Example
 
      
      [bookmark: pgfId-7728155]> show network 
     
 
    
 
     
      [bookmark: pgfId-7719974][bookmark: 47638]network-modules
 
     [bookmark: pgfId-7735194]Displays all installed modules and information about them, including serial numbers. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900388]Access
 
     [bookmark: pgfId-7747480]Basic
 
     [bookmark: pgfId-7902077]Syntax
 
      
      [bookmark: pgfId-7735208]show network-modules 
     
 
     [bookmark: pgfId-7904718]Example
 
      
      [bookmark: pgfId-7728196]> show network-modules 
     
 
    
 
     
      [bookmark: pgfId-7939751][bookmark: 23976]network-static-routes
 
     [bookmark: pgfId-7939821]Displays all configured network static routes and information about them, including interface, destination address, network mask, and gateway address.
 
     [bookmark: pgfId-7939825]Access
 
     [bookmark: pgfId-7939826]Basic
 
     [bookmark: pgfId-7939827]Syntax
 
      
      [bookmark: pgfId-7939828]show network-static-routes 
     
 
     [bookmark: pgfId-7939829]Example
 
      
      [bookmark: pgfId-7939830]> show network-static-routes 
     
 
    
 
     
      [bookmark: pgfId-7720010][bookmark: 75650]ntp
 
     [bookmark: pgfId-7735377]Displays the ntp configuration.
 
     [bookmark: pgfId-7900417]Access
 
     [bookmark: pgfId-7747500]Basic
 
     [bookmark: pgfId-7902089]Syntax
 
      
      [bookmark: pgfId-7735363]show ntp 
     
 
     [bookmark: pgfId-7904734]Example
 
      
      [bookmark: pgfId-7728231]> show ntp 
     
 
    
 
     
      [bookmark: pgfId-7768008][bookmark: 62551]perfstats
 
     [bookmark: pgfId-7768009]Displays performance statistics for the device.
 
     [bookmark: pgfId-7900437]Access
 
     [bookmark: pgfId-7768011]Basic
 
     [bookmark: pgfId-7902105]Syntax
 
      
      [bookmark: pgfId-7768013]show perfstats 
     
 
     [bookmark: pgfId-7904750]Example
 
      
      [bookmark: pgfId-7768015]> show perfstats 
     
 
    
 
     
      [bookmark: pgfId-7720037][bookmark: 26245]portstats
 
     [bookmark: pgfId-7735438]Displays port statistics for all installed ports on the device. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900457]Access
 
     [bookmark: pgfId-7747541]Basic
 
     [bookmark: pgfId-7902172]Syntax
 
      
      [bookmark: pgfId-7735424]show portstats [copper | fiber | internal | external | all] 
     
 
     [bookmark: pgfId-7740972]where copper specifies for all copper ports, fiber specifies for all fiber ports, internal specifies for all internal ports, external specifies for all external (copper and fiber) ports, and all specifies for all ports (external and internal).
 
     [bookmark: pgfId-7904762]Example
 
      
      [bookmark: pgfId-7727120]> show portstats fiber 
     
 
    
 
     
      [bookmark: pgfId-7765606][bookmark: 27492]power-supply-status
 
     [bookmark: pgfId-7765607]Displays the current state of hardware power supplies. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900481]Access
 
     [bookmark: pgfId-7765609]Basic
 
     [bookmark: pgfId-7902184]Syntax
 
      
      [bookmark: pgfId-7765611]show power-supply-status 
     
 
     [bookmark: pgfId-7904774]Example
 
      
      [bookmark: pgfId-7765593]> show power-supply-status 
     
 
    
 
     
      [bookmark: pgfId-7765727][bookmark: 51966]process-tree
 
     [bookmark: pgfId-7765728]Displays processes currently running on the device, sorted in tree format by type.
 
     [bookmark: pgfId-7900493]Access
 
     [bookmark: pgfId-7765730]Basic
 
     [bookmark: pgfId-7902212]Syntax
 
      
      [bookmark: pgfId-7765732]show process-tree 
     
 
     [bookmark: pgfId-7904786]Example
 
      
      [bookmark: pgfId-7765734]> show process-tree 
     
 
    
 
     
      [bookmark: pgfId-7718503][bookmark: 47804]processes
 
     [bookmark: pgfId-7735539]Displays processes currently running on the device, sorted by descending CPU usage.
 
     [bookmark: pgfId-7900517]Access
 
     [bookmark: pgfId-7747574]Basic
 
     [bookmark: pgfId-7902240]Syntax
 
      
      [bookmark: pgfId-7735525]show processes [sort-flag] [filter] 
     
 
     [bookmark: pgfId-7735623]where sort-flag can be -m to sort by memory (descending order), -u to sort by username rather than the process name, or verbose to display the full name and path of the command. The filter parameter specifies the search term in the command or username by which results are filtered. The header row is still displayed.
 
     [bookmark: pgfId-7904798]Example
 
      
      [bookmark: pgfId-7748629]> show processes -u user1 
     
 
    
 
     
      [bookmark: pgfId-7868278][bookmark: 94387]route
 
     [bookmark: pgfId-7868279]Displays the routing information for an ASA FirePOWER module.
 
     [bookmark: pgfId-7900529]Access
 
     [bookmark: pgfId-7868281]Basic
 
     [bookmark: pgfId-7902268]Syntax
 
      
      [bookmark: pgfId-7868283]show route 
     
 
     [bookmark: pgfId-7904810]Example
 
      
      [bookmark: pgfId-7868285]> show route 
     
 
    
 
     
      [bookmark: pgfId-7765973][bookmark: 39799]routing-table
 
     [bookmark: pgfId-7765974]If no parameters are specified, displays routing information for all virtual routers. If parameters are specified, displays routing information for the specified router and, as applicable, its specified routing protocol type. All parameters are optional. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900548]Access
 
     [bookmark: pgfId-7765887]Basic
 
     [bookmark: pgfId-7902296]Syntax
 
      
      [bookmark: pgfId-7766407]show routing-table [name] [ ospf | rip | static ] 
     
 
     [bookmark: pgfId-7766408]where name is the name of the specific router for which you want information, and ospf, rip, and static specify the routing protocol type.
 
     [bookmark: pgfId-7904837]Example
 
      
      [bookmark: pgfId-7766203]> show routing-table Vrouter1 static 
     
 
    
 
     
      [bookmark: pgfId-7765855][bookmark: 96241]serial-number
 
     [bookmark: pgfId-7735909]Displays the chassis serial number. This command is not available on virtual devices.
 
     [bookmark: pgfId-7900560]Access
 
     [bookmark: pgfId-7747641]Basic
 
     [bookmark: pgfId-7902312]Syntax
 
      
      [bookmark: pgfId-7735871]show serial-number 
     
 
     [bookmark: pgfId-7904849]Example
 
      
      [bookmark: pgfId-7782450]> show serial-number 
     
 
    
 
     
      [bookmark: pgfId-7922236][bookmark: 45603]ssl-policy-config
 
     [bookmark: pgfId-7922238]Displays the currently applied SSL policy configuration, including policy description, default logging settings, all enabled SSL rules and rule configurations, trusted CA certificates, and undecryptable traffic actions.
 
     [bookmark: pgfId-7922239]Access
 
     [bookmark: pgfId-7922240]Basic
 
     [bookmark: pgfId-7922241]Syntax
 
      
      [bookmark: pgfId-7922242]show ssl-policy-config 
     
 
     [bookmark: pgfId-7922243]Example
 
      
      [bookmark: pgfId-7922244]> show ssl-policy-config 
     
 
    
 
     
      [bookmark: pgfId-7797573][bookmark: 83807]stacking
 
     [bookmark: pgfId-7797574]Shows the stacking configuration and position on managed devices; on devices configured as primary, also lists data for all secondary devices. For clustered stacks, this command also indicates that the stack is a member of a cluster. The user must use the web interface to enable or (in most cases) disable stacking; if stacking is not enabled, the command will return Stacking not currently configured. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900592]Access
 
     [bookmark: pgfId-7797576]Basic
 
     [bookmark: pgfId-7902344]Syntax
 
      
      [bookmark: pgfId-7797578]show stacking 
     
 
     [bookmark: pgfId-7904915]Example
 
      
      [bookmark: pgfId-7797580]> show stacking 
     
 
    
 
     
      [bookmark: pgfId-7782453][bookmark: 75492]summary
 
     [bookmark: pgfId-7768138]Displays a summary of the most commonly used information (version, type, UUID, and so on) about the device. For more detailed information, see the following show commands: version, interfaces, device-settings, and access-control-config.
 
     [bookmark: pgfId-7900635]Access
 
     [bookmark: pgfId-7747668]Basic
 
     [bookmark: pgfId-7902356]Syntax
 
      
      [bookmark: pgfId-7735954]show summary 
     
 
     [bookmark: pgfId-7904980]Example
 
      
      [bookmark: pgfId-7766443]> show summary 
     
 
    
 
     
      [bookmark: pgfId-7766445][bookmark: 83858]time
 
     [bookmark: pgfId-7736077]Displays the current date and time in UTC and in the local time zone configured for the current user.
 
     [bookmark: pgfId-7900647]Access
 
     [bookmark: pgfId-7747688]Basic
 
     [bookmark: pgfId-7902368]Syntax
 
      
      [bookmark: pgfId-7736048]show time 
     
 
     [bookmark: pgfId-7905008]Example
 
      
      [bookmark: pgfId-7728375]> show time 
     
 
    
 
     
      [bookmark: pgfId-7766461][bookmark: 42293]traffic-statistics
 
     [bookmark: pgfId-7804038]If no parameters are specified, displays details about bytes transmitted and received from all ports. If a port is specified, displays that information only for the specified port. You cannot specify a port for ASA FirePOWER devices, and the system displays only the data plane interfaces.
 
     [bookmark: pgfId-7900681]Access
 
     [bookmark: pgfId-7766472]Basic
 
     [bookmark: pgfId-7902380]Syntax
 
      
      [bookmark: pgfId-7766641]show traffic-statistics [port] 
     
 
     [bookmark: pgfId-7766642]where port is the specific port for which you want information.
 
     [bookmark: pgfId-7905036]Example
 
      
      [bookmark: pgfId-7766644]> show traffic-statistics s1p1 
     
 
    
 
     
      [bookmark: pgfId-7797586][bookmark: 28678]user
 
     [bookmark: pgfId-7797587]Applicable to virtual devices only. Displays detailed configuration information for the specified user(s). The following values are displayed:
 
      
      	 [bookmark: pgfId-7797588]Login — the login name
 
      	 [bookmark: pgfId-7797589]UID — the numeric user ID 
 
      	 [bookmark: pgfId-7797590]Auth ( Local or  Remote ) — how the user is authenticated
 
      	 [bookmark: pgfId-7797591]Access ( Basic or  Config ) — the user's privilege level 
 
      	 [bookmark: pgfId-7797592]Enabled ( Enabled or  Disabled ) — whether the user is active
 
      	 [bookmark: pgfId-7797593]Reset ( Yes or  No ) — whether the user must change password at next login 
 
      	 [bookmark: pgfId-7797594]Exp ( Never or a number) — the number of days until the user's password must be changed
 
      	 [bookmark: pgfId-7797595]Warn ( N/A or a number) — the number of days a user is given to change their password before it expires
 
      	 [bookmark: pgfId-7797596]Str ( Yes or  No ) — whether the user's password must meet strength checking criteria 
 
      	 [bookmark: pgfId-7797597]Lock ( Yes or  No ) — whether the user's account has been locked due to too many login failures 
 
      	 [bookmark: pgfId-7797598]Max ( N/A or a number) — the maximum number of failed logins before the user's account is locked
 
     
 
     [bookmark: pgfId-7900693]Access
 
     [bookmark: pgfId-7797601]Configuration
 
     [bookmark: pgfId-7902392]Syntax
 
      
      [bookmark: pgfId-7797603]show user username username username ... 
     
 
     [bookmark: pgfId-7797604]where username specifies the name of the user and the usernames are space-separated.
 
     [bookmark: pgfId-7905056]Example
 
      
      [bookmark: pgfId-7797606]> show user jdoe 
     
 
    
 
     
      [bookmark: pgfId-7797608][bookmark: 46510]users
 
     [bookmark: pgfId-7797609]Applicable to virtual devices only. Displays detailed configuration information for all local users. The following values are displayed:
 
      
      	 [bookmark: pgfId-7797610]Login — the login name
 
      	 [bookmark: pgfId-7797611]UID — the numeric user ID 
 
      	 [bookmark: pgfId-7797612]Auth ( Local or  Remote ) — how the user is authenticated
 
      	 [bookmark: pgfId-7797613]Access ( Basic or  Config ) — the user's privilege level 
 
      	 [bookmark: pgfId-7797614]Enabled ( Enabled or  Disabled ) — whether the user is active
 
      	 [bookmark: pgfId-7797615]Reset ( Yes or  No ) — whether the user must change password at next login 
 
      	 [bookmark: pgfId-7797616]Exp ( Never or a number) — the number of days until the user's password must be changed
 
      	 [bookmark: pgfId-7797617]Warn ( N/A or a number) — the number of days a user is given to change their password before it expires
 
      	 [bookmark: pgfId-7797618]Str ( Yes or  No ) — whether the user's password must meet strength checking criteria 
 
      	 [bookmark: pgfId-7797619]Lock ( Yes or  No ) — whether the user's account is locked due to too many login failures 
 
      	 [bookmark: pgfId-7797620]Max ( N/A or a number) — the maximum number of failed logins before the user's account is locked
 
     
 
     [bookmark: pgfId-7900705]Access
 
     [bookmark: pgfId-7797624]Configuration
 
     [bookmark: pgfId-7902413]Syntax
 
      
      [bookmark: pgfId-7797626]show users 
     
 
     [bookmark: pgfId-7905076]Example
 
      
      [bookmark: pgfId-7797628]> show users 
     
 
    
 
     
      [bookmark: pgfId-7720376][bookmark: 76546]version
 
     [bookmark: pgfId-7736202]Displays the product version and build. If the detail parameter is specified, displays the versions of additional components.
 
     [bookmark: pgfId-7900717]Access
 
     [bookmark: pgfId-7747747]Basic
 
     [bookmark: pgfId-7902464]Syntax
 
      
      [bookmark: pgfId-7736158]show version [detail] 
     
 
     [bookmark: pgfId-7905106]Example
 
      
      [bookmark: pgfId-7727206]> show version 
     
 
    
 
     
      [bookmark: pgfId-7766747][bookmark: 65911]virtual-routers
 
     [bookmark: pgfId-7766890]If no parameters are specified, displays a list of all currently configured virtual routers with DHCP relay, OSPF, and RIP information. If parameters are specified, displays information for the specified router, limited by the specified route type. All parameters are optional. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900745]Access
 
     [bookmark: pgfId-7766892]Basic
 
     [bookmark: pgfId-7902476]Syntax
 
      
      [bookmark: pgfId-7766913]show virtual-routers [ dhcprelay | ospf | rip ] [name] 
     
 
     [bookmark: pgfId-7766914]where dhcprelay, ospf, and rip specify for route types, and name is the name of the specific router for which you want information. If you specify ospf, you can then further specify neighbors, topology, or lsadb between the route type and (if present) the router name.
 
     [bookmark: pgfId-7905126]Example
 
      
      [bookmark: pgfId-7766916]> show virtual-routers ospf VRouter2 
     
 
    
 
     
      [bookmark: pgfId-7767020][bookmark: 22995]virtual-switches
 
     [bookmark: pgfId-7767021]If no parameters are specified, displays a list of all currently configured virtual switches. If parameters are specified, displays information for the specified switch. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900757]Access
 
     [bookmark: pgfId-7767023]Basic
 
     [bookmark: pgfId-7902488]Syntax
 
      
      [bookmark: pgfId-7767025]show virtual-switches [name] 
     
 
     [bookmark: pgfId-7905138]Example
 
      
      [bookmark: pgfId-7916311]> show virtual-switches Vswitch1 
     
 
    
 
     
      [bookmark: pgfId-7922250][bookmark: 76314]vmware-tools
 
     [bookmark: pgfId-7922254]Indicates whether VMware Tools are currently enabled on a virtual device. This command is available only on virtual devices.
 
     [bookmark: pgfId-7922258]VMware Tools is a suite of utilities intended to enhance the performance of the virtual machine. These utilities allow you to make full use of the convenient features of VMware products. The system supports the following plugins on all virtual appliances:
 
      
      	 [bookmark: pgfId-7922262]guestInfo
 
      	 [bookmark: pgfId-7922263]powerOps
 
      	 [bookmark: pgfId-7943167]snapshot
 
      	 [bookmark: pgfId-7922264]timeSync
 
      	 [bookmark: pgfId-7922265]vmbackup
 
     
 
     [bookmark: pgfId-7922272]For more information about VMware Tools and the supported plugins, see the VMware website (http://www.vmware.com).
 
     [bookmark: pgfId-7922274]Access
 
     [bookmark: pgfId-7922275]Basic
 
     [bookmark: pgfId-7922276]Syntax
 
      
      [bookmark: pgfId-7922277]show vmware-tools 
     
 
     [bookmark: pgfId-7922278]Example
 
      
      [bookmark: pgfId-7922279]> show vmware-tools 
     
 
    
 
     
      [bookmark: pgfId-7916313]VPN
 
     [bookmark: pgfId-7836464]The show VPN commands display VPN status and configuration information for VPN connections. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900785]Access
 
     [bookmark: pgfId-7836300]Basic
 
    
 
     
      [bookmark: pgfId-7836301]config
 
     [bookmark: pgfId-7836302]Displays the configuration of all VPN connections.
 
     [bookmark: pgfId-7902500]Syntax
 
      
      [bookmark: pgfId-7836304]show vpn config 
     
 
     [bookmark: pgfId-7905154]Example
 
      
      [bookmark: pgfId-7836306]> show vpn config 
     
 
    
 
     
      [bookmark: pgfId-7836307]config by virtual router
 
     [bookmark: pgfId-7836308]Displays the configuration of all VPN connections for a virtual router.
 
     [bookmark: pgfId-7902512]Syntax
 
      
      [bookmark: pgfId-7836310]show vpn config [virtual router] 
     
 
     [bookmark: pgfId-7905170]Example
 
      
      [bookmark: pgfId-7836312]> show vpn config VRouter1 
     
 
    
 
     
      [bookmark: pgfId-7836313]status
 
     [bookmark: pgfId-7836314]Displays the status of all VPN connections.
 
     [bookmark: pgfId-7902532]Syntax
 
      
      [bookmark: pgfId-7836316]show vpn status 
     
 
     [bookmark: pgfId-7905186]Example
 
      
      [bookmark: pgfId-7836318]> show vpn status 
     
 
    
 
     
      [bookmark: pgfId-7836319]status by virtual router
 
     [bookmark: pgfId-7836320]Displays the status of all VPN connections for a virtual router.
 
     [bookmark: pgfId-7902544]Syntax
 
      
      [bookmark: pgfId-7836322]show vpn status [virtual router] 
     
 
     [bookmark: pgfId-7905202]Example
 
      
      [bookmark: pgfId-7836324]> show vpn status VRouter1 
     
 
    
 
     
      [bookmark: pgfId-7836326]counters
 
     [bookmark: pgfId-7836327]Displays the counters for all VPN connections.
 
     [bookmark: pgfId-7902560]Syntax
 
      
      [bookmark: pgfId-7837216]show vpn counters 
     
 
     [bookmark: pgfId-7905217]Example
 
      
      [bookmark: pgfId-7837161]> show vpn counters 
     
 
    
 
     
      [bookmark: pgfId-7836333]counters by virtual router
 
     [bookmark: pgfId-7836334]Displays the counters of all VPN connections for a virtual router.
 
     [bookmark: pgfId-7902572]Syntax
 
      
      [bookmark: pgfId-7836336]show vpn counters [virtual router] 
     
 
     [bookmark: pgfId-7905243]Example
 
      
      [bookmark: pgfId-7836338]> show vpn counters VRouter1 
     
 
    
 
   
 
    
     [bookmark: pgfId-7766898][bookmark: 43539]Configuration Commands
 
    [bookmark: pgfId-7740752]The configuration commands enable the user to configure and manage the system. These commands affect system operation; therefore, with the exception of Basic-level configure password, only users with configuration CLI access can issue these commands.
 
    [bookmark: pgfId-7736264]The following sections describe the configuration commands:
 
     
     	 [bookmark: pgfId-7717937]clustering
 
     	 [bookmark: pgfId-7772966]bypass
 
     	 [bookmark: pgfId-7767826]gui
 
     	 [bookmark: pgfId-7972990]iab
 
     	 [bookmark: pgfId-7748667]lcd
 
     	 [bookmark: pgfId-7822400]log-ips-connections
 
     	 [bookmark: pgfId-7717955]manager
 
     	 [bookmark: pgfId-7769227]mpls-depth
 
     	 [bookmark: pgfId-7717962]network
 
     	 [bookmark: pgfId-7773057]password
 
     	 [bookmark: pgfId-7799882]stacking disable
 
     	 [bookmark: pgfId-7797636]user
 
     	 [bookmark: pgfId-7922287]vmware-tools
 
    
 
     
      [bookmark: pgfId-7767742][bookmark: 34634]clustering
 
     [bookmark: pgfId-7767743]Disables or configures bypass for clustering on the device. This command is not available on virtual devices, ASA FirePOWER devices, or on devices configured as secondary stack members.
 
     [bookmark: pgfId-7900797]Access
 
     [bookmark: pgfId-7767745]Configuration
 
     [bookmark: pgfId-7902584]Syntax
 
      
      [bookmark: pgfId-7767747]configure clustering {disable | bypass} 
     
 
     [bookmark: pgfId-7905255]Example
 
      
      [bookmark: pgfId-7768858]> configure clustering disable 
     
 
    
 
     
      [bookmark: pgfId-7768925][bookmark: 56008]bypass
 
     [bookmark: pgfId-7769058]On Series 3 devices, places an inline pair in fail-open (hardware bypass) or fail-close mode. You can use this command only when the Bypass Mode inline set option is set to Bypass.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7948372] 
      Caution You cannot apply an access control policy or reapply an intrusion policy to a managed device where this command has put an inline set into fail-open mode. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7950997]Note that rebooting a device takes an interface pair out of fail-open made. 
 
     [bookmark: pgfId-7900821]Access
 
     [bookmark: pgfId-7768928]Configuration
 
     [bookmark: pgfId-7902600]Syntax
 
      
      [bookmark: pgfId-7768930]configure bypass {open | close} {interface} 
     
 
     [bookmark: pgfId-7769129]where interface is the name of either hardware port in the inline pair.
 
     [bookmark: pgfId-7905267]Example
 
      
      [bookmark: pgfId-7768932]> configure bypass open s1p1 
     
 
    
 
     
      [bookmark: pgfId-7768860][bookmark: 12053]gui
 
     [bookmark: pgfId-7768861]Enables or disables the device web interface, including the streamlined upgrade web interface that appears during major updates to the system. This command is not available on virtual devices and ASA FirePOWER devices.
 
     [bookmark: pgfId-7900845]Access
 
     [bookmark: pgfId-7747795]Configuration
 
     [bookmark: pgfId-7953128]Syntax
 
      
      [bookmark: pgfId-7953129]configure gui {enable | disable} 
     
 
     [bookmark: pgfId-7953130]Example
 
      
      [bookmark: pgfId-7821539]> configure gui disable 
     
 
    
 
     
      [bookmark: pgfId-7952909][bookmark: 15467]iab
 
     [bookmark: pgfId-7952921]Configure Intelligent Application Bypass (IAB). This command requires Version 5.4.0.10 or later on the managed device. The Defense Center requires Version 5.4.1.9 or later to implement IAB functionality, and Version 5.4.1.10 or later to provide IAB events.
 
     [bookmark: pgfId-7970768]IAB trusts traffic to traverse your network without further inspection if performance and flow thresholds are exceeded. The system implements IAB on traffic allowed by access control rules or the access control policy's default action, before the traffic is subject to deep inspection. A test mode allows you to determine whether thresholds are exceeded and, if so, to identify the flows that would have been trusted if you had actually enabled IAB. You must deploy your access control policy to the managed device after configuring IAB.
 
      
      [bookmark: pgfId-7970775]Parameter 
     
 
      
      [bookmark: pgfId-7970777]Description 
     
 
     [bookmark: pgfId-7970779]on
 
     [bookmark: pgfId-7970781]Configures IAB in active mode.
 
     [bookmark: pgfId-7970783]test
 
     [bookmark: pgfId-7970785]Configures IAB in test mode.
 
     [bookmark: pgfId-7970787]disable
 
     [bookmark: pgfId-7970789]Disables IAB.
 
    
 
    [bookmark: pgfId-7970795]Performance and Flow Thresholds
 
    [bookmark: pgfId-7966019]You must set a performance scan interval and configure at least one of four inspection performance thresholds and one of four flow bypass thresholds. When a performance threshold is exceeded, the system examines flow thresholds and, if a flow threshold is exceeded, trusts traffic. If you configure more than one of either type of threshold, only one of each must be exceeded. All thresholds are disabled (set to 0) by default. 
 
    [bookmark: pgfId-7965822]Inspection performance thresholds—provide intrusion inspection performance limits that, if exceeded, trigger the inspection of flow thresholds. IAB does not use inspection performance thresholds set to 0.
 
     
      [bookmark: pgfId-7966190]
 
      
       
        
        [bookmark: pgfId-7966085]Table D-2 Inspection Performance Threshold Parameters
 
        
        
         
         	 
           
           [bookmark: pgfId-7966093]Parameter 
          
  
         	 
           
           [bookmark: pgfId-7966095]Descriptive Name 
          
  
         	 
           
           [bookmark: pgfId-7966097]Description 
          
  
         	 
           
           [bookmark: pgfId-7966099]Range 
          
  
        
 
         
         	[bookmark: pgfId-7966101]interval
  
         	[bookmark: pgfId-7966103]Performance Sample Interval
  
         	[bookmark: pgfId-7966105]The time between IAB performance sampling scans, during which the system collects system performance metrics for comparison to IAB performance thresholds.
  
         	[bookmark: pgfId-7966107]1 - 1000 seconds 
  
        
 
         
         	[bookmark: pgfId-7966118]drops
  
         	[bookmark: pgfId-7966120]Drop Percentage
  
         	[bookmark: pgfId-7966122]Average packets dropped as a percentage of total packets, when packets are dropped because of performance overloads caused by expensive intrusion rules, file policies, decompression, and so on. This does not refer to packets dropped by normal configurations such as intrusion rules. Note that specifying an integer greater than 1 activates IAB when the specified percentage of packets is dropped. When you specify 1, any percentage from 0 through 1 activates IAB. This allows a small number of packets to activate IAB.
  
         	[bookmark: pgfId-7966124]0 - 100 percent
  
        
 
         
         	[bookmark: pgfId-7966126]cpu
  
         	[bookmark: pgfId-7966128]Processor Utilization Percentage
  
         	[bookmark: pgfId-7966130]Average percentage of processor resources used.
  
         	[bookmark: pgfId-7966132]0 - 100 percent
  
        
 
         
         	[bookmark: pgfId-7966134]latency
  
         	[bookmark: pgfId-7966136]Packet Latency
  
         	[bookmark: pgfId-7966138]Average packet latency.
  
         	[bookmark: pgfId-7966140]0 - 1000000 microseconds 
  
        
 
         
         	[bookmark: pgfId-7966142]rate
  
         	[bookmark: pgfId-7966144]Flow Rate
  
         	[bookmark: pgfId-7966146]The rate at which the system processes flows, measured as the number of flows per second. Note that this option configures IAB to measure flow rate, not flow count.
  
         	[bookmark: pgfId-7966148]0 - 1000000 flows/second 
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7967207]Flow bypass thresholds—provide flow limits that, if exceeded, trigger IAB to trust traffic in active mode or allow traffic subject to further inspection in test mode. IAB does not use flow bypass thresholds set to 0.
 
    
 
     
      [bookmark: pgfId-7967339]
 
      
       
        
        [bookmark: pgfId-7967243]Table D-3 Flow Bypass Threshold Parameters
 
        
        
         
         	 
           
           [bookmark: pgfId-7967251]Parameter 
          
  
         	 
           
           [bookmark: pgfId-7967253]Descriptive Name 
          
  
         	 
           
           [bookmark: pgfId-7967255]Description 
          
  
         	 
           
           [bookmark: pgfId-7967257]Range 
          
  
        
 
         
         	[bookmark: pgfId-7967308]kbytes
  
         	[bookmark: pgfId-7967310]Bytes per Flow
  
         	[bookmark: pgfId-7967312]The maximum number of kilobytes a flow can include.
  
         	[bookmark: pgfId-7967314]0 - 2147483647 kilobytes
  
        
 
         
         	[bookmark: pgfId-7967316]packets
  
         	[bookmark: pgfId-7967318]Packets per Flow
  
         	[bookmark: pgfId-7967320]The maximum number of packets a flow can include.
  
         	[bookmark: pgfId-7967322]0 - 2147483647 packets
  
        
 
         
         	[bookmark: pgfId-7967324]duration
  
         	[bookmark: pgfId-7967326]Flow Duration
  
         	[bookmark: pgfId-7967328]The maximum number of seconds a flow can remain open.
  
         	[bookmark: pgfId-7967330]0 - 2147483647 seconds
  
        
 
         
         	[bookmark: pgfId-7967332]velocity
  
         	[bookmark: pgfId-7967334]Flow Velocity
  
         	[bookmark: pgfId-7967336]The maximum transfer rate in kilobytes per second. 
  
         	[bookmark: pgfId-7967338]0 - 2147483647 kilobytes/second
  
        
 
        
      
 
     
 
     [bookmark: pgfId-7968677]You configure all parameters at the same time and in order. The system prompts you for the next parameter if you enter fewer than the maximum number of parameters.
 
     [bookmark: pgfId-7965303]Access
 
     [bookmark: pgfId-7969063]Configuration
 
     [bookmark: pgfId-7960523]Syntax
 
      
      [bookmark: pgfId-7960524]configure iab {on | test} interval drops cpu latency rate kbytes packets duration velocity  
     
 
     [bookmark: pgfId-7972160]Example
 
      
      [bookmark: pgfId-7972161]configure iab on 5 1 95 250 0 500000 0 0 25000 
     
 
     [bookmark: pgfId-7972164]Related Command
 
      
      [bookmark: pgfId-7961561]show iab 
     
 
    
 
   
 
    
     [bookmark: pgfId-7720435][bookmark: 25634]lcd
 
    [bookmark: pgfId-7748700]Enables or disables the LCD display on the front of the device. This command is not available on virtual devices and ASA FirePOWER devices.
 
    [bookmark: pgfId-7900865]Access
 
    [bookmark: pgfId-7748707]Configuration
 
    [bookmark: pgfId-7902632]Syntax
 
     
     [bookmark: pgfId-7748709]configure lcd {enable | disable} 
    
 
    [bookmark: pgfId-7905299]Example
 
     
     [bookmark: pgfId-7821630]> configure lcd disable 
    
 
   
 
    
     [bookmark: pgfId-7821641][bookmark: 97409]log-ips-connections
 
    [bookmark: pgfId-7821703]Enables or disables logging of connection events that are associated with logged intrusion events.
 
    [bookmark: pgfId-7821781]Access
 
    [bookmark: pgfId-7821782]Configuration
 
    [bookmark: pgfId-7902644]Syntax
 
     
     [bookmark: pgfId-7821784]configure log-ips-connections {enable | disable} 
    
 
    [bookmark: pgfId-7905315]Example
 
     
     [bookmark: pgfId-7821786]> configure log-ips-connections disable 
    
 
   
 
    
     [bookmark: pgfId-7821632][bookmark: 34301]manager
 
    [bookmark: pgfId-7821633]The configure manager commands configure the device’s connection to its managing Defense Center.
 
    [bookmark: pgfId-7900885]Access
 
    [bookmark: pgfId-7748020]Configuration
 
   
 
    
     [bookmark: pgfId-7728716]add
 
    [bookmark: pgfId-7729284]Configures the device to accept a connection from a managing Defense Center. This command works only if the device is not actively managed.
 
    [bookmark: pgfId-7739183]A unique alphanumeric registration key is always required to register a device to a Defense Center. In most cases, you must provide the hostname or the IP address along with the registration key. However, if the device and the Defense Center are separated by a NAT device, you must enter a unique NAT ID, along with the registration key, and specify DONTRESOLVE instead of the hostname.
 
    [bookmark: pgfId-7902656]Syntax
 
     
     [bookmark: pgfId-7729633]configure manager add {hostname | IPv4_address | IPv6_address | DONTRESOLVE} regkey [nat_id] 
    
 
    [bookmark: pgfId-7739029]where {hostname | IPv4_address | IPv6_address | DONTRESOLVE} specifies the DNS host name or IP address (IPv4 or IPv6) of the Defense Center that manages this device. If the Defense Center is not directly addressable, use DONTRESOLVE. If you use DONTRESOLVE,nat_id is required. regkey is the unique alphanumeric registration key required to register a device to the Defense Center. nat_id is an optional alphanumeric string used during the registration process between the Defense Center and the device. It is required if the hostname is set to DONTRESOLVE.
 
    [bookmark: pgfId-7905331]Example
 
     
     [bookmark: pgfId-7728877]> configure manager add DONTRESOLVE abc123 efg456 
    
 
   
 
    
     [bookmark: pgfId-7722117]delete
 
    [bookmark: pgfId-7729576]Removes the Defense Center’s connection information from the device. This command only works if the device is not actively managed.
 
    [bookmark: pgfId-7902668]Syntax
 
     
     [bookmark: pgfId-7729584]configure manager delete 
    
 
    [bookmark: pgfId-7905343]Example
 
     
     [bookmark: pgfId-7729612]> configure manager delete 
    
 
   
 
    
     [bookmark: pgfId-7769166][bookmark: 98666]mpls-depth
 
    [bookmark: pgfId-7769167]Configures the number of MPLS layers on the management interface. This command is not available on virtual devices and ASA FirePOWER devices.
 
    [bookmark: pgfId-7900905]Access
 
    [bookmark: pgfId-7769169]Configuration
 
    [bookmark: pgfId-7902708]Syntax
 
     
     [bookmark: pgfId-7769171]configure mpls-depth {depth} 
    
 
    [bookmark: pgfId-7769172]where depth is a number between 0 and 6.
 
    [bookmark: pgfId-7905378]Example
 
     
     [bookmark: pgfId-7769174]> configure mpls-depth 3 
    
 
   
 
    
     [bookmark: pgfId-7763531][bookmark: 64351]network 
 
    [bookmark: pgfId-7763532]The configure network commands configure the device’s management interface.
 
    [bookmark: pgfId-7900924]Access
 
    [bookmark: pgfId-7748047]Configuration
 
   
 
    
     [bookmark: pgfId-7736702]dns searchdomains
 
    [bookmark: pgfId-7736662]Replaces the current list of DNS search domains with the list specified in the command.
 
    [bookmark: pgfId-7902748]Syntax
 
     
     [bookmark: pgfId-7736739]configure network dns searchdomains {searchlist} 
    
 
    [bookmark: pgfId-7739402]where searchlist is a comma-separated list of domains.
 
    [bookmark: pgfId-7905406]Example
 
     
     [bookmark: pgfId-7727283]> configure network dns searchdomains foo.bar.com,bar.com 
    
 
   
 
    
     [bookmark: pgfId-7722203]dns servers
 
    [bookmark: pgfId-7736874]Replaces the current list of DNS servers with the list specified in the command.
 
    [bookmark: pgfId-7902788]Syntax
 
     
     [bookmark: pgfId-7722204]configure nework dns servers {dnslist} 
    
 
    [bookmark: pgfId-7739584]where dnslist is a comma-separated list of DNS servers.
 
    [bookmark: pgfId-7905434]Example
 
     
     [bookmark: pgfId-7727298]> configure network dns servers 10.123.1.10,10.124.1.10 
    
 
   
 
    
     [bookmark: pgfId-7722233]hostname
 
    [bookmark: pgfId-7736954]Sets the hostname for the device.
 
    [bookmark: pgfId-7902820]Syntax
 
     
     [bookmark: pgfId-7736956]configure network hostname {name} 
    
 
    [bookmark: pgfId-7739614]where name is the new hostname.
 
    [bookmark: pgfId-7905462]Example
 
     
     [bookmark: pgfId-7736958]> configure network hostname sfrocks 
    
 
   
 
    
     [bookmark: pgfId-7722356][bookmark: 70467]http-proxy
 
    [bookmark: pgfId-7856245]On Series 3 and virtual devices, configures an HTTP proxy. After issuing the command, the CLI prompts the user for the HTTP proxy address and port, whether proxy authentication is required, and if it is required, the proxy username, proxy password, and confirmation of the proxy password.
 
    [bookmark: pgfId-7856858]Use this command on a virtual device to configure an HTTP proxy server so the virtual device can submit files to the Collective Security Intelligence Cloud for dynamic analysis.
 
    [bookmark: pgfId-7902852]Syntax
 
     
     [bookmark: pgfId-7856704]configure network http-proxy 
    
 
    [bookmark: pgfId-7905490]Example
 
     
     [bookmark: pgfId-7856743]> configure network http-proxy 
    
 
     
     [bookmark: pgfId-7856792]Manual proxy configuration 
    
 
     
     [bookmark: pgfId-7856793]Enter HTTP Proxy address:  
    
 
     
     [bookmark: pgfId-7856794]Enter HTTP Proxy Port:  
    
 
     
     [bookmark: pgfId-7856795]Use Proxy Authentication? (y/n) [n]:  
    
 
     
     [bookmark: pgfId-7856796]Enter Proxy Username:  
    
 
     
     [bookmark: pgfId-7856797]Enter Proxy Password:  
    
 
     
     [bookmark: pgfId-7856775]Confirm Proxy Password:  
    
 
   
 
    
     [bookmark: pgfId-7856146]http-proxy-disable
 
    [bookmark: pgfId-7856320]On Series 3 and virtual devices, deletes any HTTP proxy configuration.
 
    [bookmark: pgfId-7902884]Syntax
 
     
     [bookmark: pgfId-7857041]configure network http-proxy-disable 
    
 
    [bookmark: pgfId-7905506]Example
 
     
     [bookmark: pgfId-7857076]> configure network http-proxy-disable 
    
 
     
     [bookmark: pgfId-7857089]Are you sure that you wish to delete the current http-proxy configuration? (y/n): 
    
 
   
 
    
     [bookmark: pgfId-7856109]ipv4 delete
 
    [bookmark: pgfId-7736976]Disables the IPv4 configuration of the device’s management interface.
 
    [bookmark: pgfId-7902916]Syntax
 
     
     [bookmark: pgfId-7736978]configure network ipv4 delete 
    
 
    [bookmark: pgfId-7905522]Example
 
     
     [bookmark: pgfId-7736980]> configure network ipv4 delete 
    
 
   
 
    
     [bookmark: pgfId-7722379]ipv4 dhcp
 
    [bookmark: pgfId-7737006]Sets the IPv4 configuration of the device’s management interface to DHCP. The management interface communicates with the DHCP server to obtain its configuration information.
 
    [bookmark: pgfId-7902940]Syntax
 
     
     [bookmark: pgfId-7737008]configure network ipv4 dhcp 
    
 
    [bookmark: pgfId-7905538]Example
 
     
     [bookmark: pgfId-7737299]> configure network ipv4 dhcp 
    
 
   
 
    
     [bookmark: pgfId-7737300]ipv4 manual
 
    [bookmark: pgfId-7737301]Manually configures the IPv4 configuration of the device’s management interface.
 
    [bookmark: pgfId-7902964]Syntax
 
     
     [bookmark: pgfId-7737323]configure network ipv4 manual ipaddr netmask gw 
    
 
    [bookmark: pgfId-7739660]where ipaddr is the IP address, netmask is the subnet mask, and gw is the IPv4 address of the default gateway.
 
    [bookmark: pgfId-7905571]Example
 
     
     [bookmark: pgfId-7754950]> configure network ipv4 manual 10.123.1.10 255.255.0.0 10.123.1.1 
    
 
   
 
    
     [bookmark: pgfId-7722430]ipv6 delete
 
    [bookmark: pgfId-7737042]Disables the IPv6 configuration of the device’s management interface.
 
    [bookmark: pgfId-7902988]Syntax
 
     
     [bookmark: pgfId-7737044]configure network ipv6 delete 
    
 
    [bookmark: pgfId-7905583]Example
 
     
     [bookmark: pgfId-7737357]> configure network ipv6 delete 
    
 
   
 
    
     [bookmark: pgfId-7722451]ipv6 dhcp
 
    [bookmark: pgfId-7737090]Sets the IPv6 configuration of the device’s management interface to DHCP. The management interface communicates with the DHCP server to obtain its configuration information.
 
    [bookmark: pgfId-7903012]Syntax
 
     
     [bookmark: pgfId-7737092]configure network ipv6 dhcp 
    
 
    [bookmark: pgfId-7905595]Example
 
     
     [bookmark: pgfId-7737379]> configure network ipv6 dhcp 
    
 
   
 
    
     [bookmark: pgfId-7722474]ipv6 router
 
    [bookmark: pgfId-7737106]Sets the IPv6 configuration of the device’s management interface to Router. The management interface communicates with the IPv6 router to obtain its configuration information.
 
    [bookmark: pgfId-7903036]Syntax
 
     
     [bookmark: pgfId-7737402]configure network ipv6 router 
    
 
    [bookmark: pgfId-7905607]Example
 
     
     [bookmark: pgfId-7737414]> configure network ipv6 router 
    
 
   
 
    
     [bookmark: pgfId-7722493]ipv6 manual
 
    [bookmark: pgfId-7737136]Manually configures the IPv6 configuration of the device’s management interface.
 
    [bookmark: pgfId-7903056]Syntax
 
     
     [bookmark: pgfId-7738771]configure network ipv6 manual ip6addr/ip6prefix [ip6gw] 
    
 
    [bookmark: pgfId-7739712]where ip6addr/ip6prefix is the IP address and prefix length and ip6gw is the IPv6 address of the default gateway.
 
    [bookmark: pgfId-7905650]Example
 
     
     [bookmark: pgfId-7936345]> configure network ipv6 manual 2001:DB8:3ffe:1900:4545:3:200:f8ff:fe21:67cf 64 
    
 
   
 
    
     [bookmark: pgfId-7936387]management-interface disable
 
    [bookmark: pgfId-7936388]Disables the specified management interface.
 
    [bookmark: pgfId-7936949]Syntax
 
     
     [bookmark: pgfId-7936950]configure network management-interface disable ethn 
    
 
    [bookmark: pgfId-7936951]where n is the number of the management interface you want to disable.
 
    [bookmark: pgfId-7937931]Example
 
     
     [bookmark: pgfId-7937932]> configure network management-interface disable eth1 
    
 
   
 
    
     [bookmark: pgfId-7937933]management-interface disable-event-channel
 
    [bookmark: pgfId-7936562]Disables event transmission over the specified management interface.
 
    [bookmark: pgfId-7936563]Syntax
 
     
     [bookmark: pgfId-7936564]configure network management-interface disable-event-channel ethn 
    
 
    [bookmark: pgfId-7936565]where n is the number of the management interface you want to disable.
 
    [bookmark: pgfId-7936566]Example
 
     
     [bookmark: pgfId-7936567]> configure network management-interface disable-event-channel eth1 
    
 
   
 
    
     [bookmark: pgfId-7936621]management-interface disable-management-channel
 
    [bookmark: pgfId-7936622]Disables management transmission over the specified management interface.
 
    [bookmark: pgfId-7936623]Syntax
 
     
     [bookmark: pgfId-7937970]configure network management-interface disable-management-channel ethn 
    
 
    [bookmark: pgfId-7937971]where n is the number of the management interface you want to disable.
 
    [bookmark: pgfId-7937972]Example
 
     
     [bookmark: pgfId-7936627]> configure network management-interface disable-management-channel eth1 
    
 
   
 
    
     [bookmark: pgfId-7936671]management-interface enable
 
    [bookmark: pgfId-7936672]Enables the specified management interface.
 
    [bookmark: pgfId-7936673]Syntax
 
     
     [bookmark: pgfId-7936674]configure network management-interface enable ethn 
    
 
    [bookmark: pgfId-7936675]where n is the number of the management interface you want to enable.
 
    [bookmark: pgfId-7936676]Example
 
     
     [bookmark: pgfId-7936677]> configure network management-interface enable eth1 
    
 
   
 
    
     [bookmark: pgfId-7937177]management-interface enable-event-channel
 
    [bookmark: pgfId-7937178]Enables event transmission over the specified management interface.
 
    [bookmark: pgfId-7937179]Syntax
 
     
     [bookmark: pgfId-7937180]configure network management-interface enable-event-channel ethn 
    
 
    [bookmark: pgfId-7937181]where n is the number of the management interface you want to enable.
 
    [bookmark: pgfId-7937182]Example
 
     
     [bookmark: pgfId-7937183]> configure network management-interface enable-event-channel eth1 
    
 
   
 
    
     [bookmark: pgfId-7937184]management-interface enable-management-channel
 
    [bookmark: pgfId-7937185]Enables management transmission over the specified management interface.
 
    [bookmark: pgfId-7937186]Syntax
 
     
     [bookmark: pgfId-7937187]configure network management-interface enable-management-channel ethn 
    
 
    [bookmark: pgfId-7937188]where n is the number of the management interface you want to enable.
 
    [bookmark: pgfId-7937189]Example
 
     
     [bookmark: pgfId-7937190]> configure network management-interface enable-management-channel eth1 
    
 
   
 
    
     [bookmark: pgfId-7937554]management-interface tcpport
 
    [bookmark: pgfId-7937555]Changes the value of the TCP port for management. 
 
    [bookmark: pgfId-7937556]Syntax
 
     
     [bookmark: pgfId-7938329]configure network management-interface tcpport port 
    
 
    [bookmark: pgfId-7938330]where port is the management port value you want to configure.
 
    [bookmark: pgfId-7938331]Example
 
     
     [bookmark: pgfId-7936590]> configure network management-interface tcpport 8500 
    
 
   
 
    
     [bookmark: pgfId-7936346]management-port
 
    [bookmark: pgfId-7936347]Sets the value of the device’s TCP management port.
 
    [bookmark: pgfId-7903076]Syntax
 
     
     [bookmark: pgfId-7798608]configure network management-port number 
    
 
    [bookmark: pgfId-7798718]where number is the management port value you want to configure.
 
    [bookmark: pgfId-7905688]Example
 
     
     [bookmark: pgfId-7798610]> configure network management-port 8500 
    
 
   
 
    
     [bookmark: pgfId-7939322]static-routes ipv4 add
 
    [bookmark: pgfId-7939323]Adds an IPv4 static route for the specified management interface.
 
    [bookmark: pgfId-7939324]Syntax
 
     
     [bookmark: pgfId-7937468]configure network static-routes ipv4 add interface destination netmask gateway 
    
 
    [bookmark: pgfId-7937469]where interface is the management interface, destination is the destination IP address, netmask is the network mask address, and gateway is the gateway address you want to add.
 
    [bookmark: pgfId-7937470]Example
 
     
     [bookmark: pgfId-7937471]> configure network static-routes ipv4 add eth1 10.115.24.0 255.255.255.0 10.115.9.2 
    
 
   
 
    
     [bookmark: pgfId-7938689]static-routes ipv4 delete
 
    [bookmark: pgfId-7938690]Deletes an IPv4 static route for the specified management interface.
 
    [bookmark: pgfId-7938691]Syntax
 
     
     [bookmark: pgfId-7938692]configure network static-routes ipv4 delete interface destination netmask gateway 
    
 
    [bookmark: pgfId-7938693]where interface is the management interface, destination is the destination IP address, netmask is the network mask address, and gateway is the gateway address you want to delete.
 
    [bookmark: pgfId-7938694]Example
 
     
     [bookmark: pgfId-7938695]> configure network static-routes ipv4 delete eth1 10.115.24.0 255.255.255.0 10.115.9.2 
    
 
   
 
    
     [bookmark: pgfId-7938720]static-routes ipv6 add
 
    [bookmark: pgfId-7939736]Adds an IPv6 static route for the specified management interface.
 
    [bookmark: pgfId-7939737]Syntax
 
     
     [bookmark: pgfId-7939738]configure network static-routes ipv6 add interface destination prefix gateway 
    
 
    [bookmark: pgfId-7938724]where interface is the management interface, destination is the destination IP address, prefix is the IPv6 prefix length, and gateway is the gateway address you want to add.
 
    [bookmark: pgfId-7938725]Example
 
     
     [bookmark: pgfId-7939599]> configure network static-routes ipv6 add eth1 2001:DB8:3ffe:1900:4545:3:200: f8ff:fe21:67cf 64 
    
 
   
 
    
     [bookmark: pgfId-7939600]static-routes ipv6 delete
 
    [bookmark: pgfId-7938746]Deletes an IPv6 static route for the specified management interface.
 
    [bookmark: pgfId-7938904]Syntax
 
     
     [bookmark: pgfId-7938905]configure network static-routes ipv6 delete interface destination prefix gateway 
    
 
    [bookmark: pgfId-7938906]where interface is the management interface, destination is the destination IP address, prefix is the IPv6 prefix length, and gateway is the gateway address you want to delete.
 
    [bookmark: pgfId-7938907]Example
 
     
     [bookmark: pgfId-7938908]> configure network static-routes ipv6 delete eth1 2001:DB8:3ffe:1900:4545:3:200:f8ff: fe21:67cf 64 
    
 
   
 
    
     [bookmark: pgfId-7773010][bookmark: 31549]password
 
    [bookmark: pgfId-7773011]Allows the current user to change their password. After issuing the command, the CLI prompts the user for their current (or old) password, then prompts the user to enter the new password twice.
 
    [bookmark: pgfId-7900936]Access
 
    [bookmark: pgfId-7773013]Basic
 
    [bookmark: pgfId-7903092]Syntax
 
     
     [bookmark: pgfId-7773015]configure password 
    
 
    [bookmark: pgfId-7905700]Example
 
     
     [bookmark: pgfId-7773017]> configure password 
    
 
     
     [bookmark: pgfId-7773018]Enter current password: 
    
 
     
     [bookmark: pgfId-7773019]Enter new password: 
    
 
     
     [bookmark: pgfId-7799938]Confirm new password: 
    
 
   
 
    
     [bookmark: pgfId-7799940][bookmark: 17373]stacking disable
 
    [bookmark: pgfId-7799941]On managed devices, removes any stacking configuration present on that device: on devices configured as primary, the stack is removed entirely; on devices configured as secondary, that device is removed from the stack. This command is not available on virtual devices or ASA FirePOWER devices and you cannot use it to break a clustered stack.
 
    [bookmark: pgfId-7799942]Use this command when you cannot establish communication with appliances higher in the stacking hierarchy. If the Defense Center is available for communication, a message appears instructing you to use the Defense Center web interface instead; likewise, if you enter stacking disable on a device configured as secondary when the primary device is available, a message appears instructing you to enter the command from the primary device.
 
    [bookmark: pgfId-7900948]Access
 
    [bookmark: pgfId-7799950]Configuration
 
    [bookmark: pgfId-7903108]Syntax
 
     
     [bookmark: pgfId-7799952]configure stacking disable 
    
 
    [bookmark: pgfId-7905712]Example
 
     
     [bookmark: pgfId-7799954]> configure stacking disable 
    
 
   
 
    
     [bookmark: pgfId-7799956][bookmark: 11645]user
 
    [bookmark: pgfId-7803629]Applicable only to virtual devices, the configure user commands manage the device’s local user database.
 
    [bookmark: pgfId-7900968]Access
 
    [bookmark: pgfId-7797685]Configuration
 
    [bookmark: pgfId-7900988]Access
 
    [bookmark: pgfId-7797687]Modifies the access level of the specified user. This command takes effect the next time the specified user logs in.
 
    [bookmark: pgfId-7903120]Syntax
 
     
     [bookmark: pgfId-7797689]configure user access username [basic | config] 
    
 
    [bookmark: pgfId-7905728]Example
 
     
     [bookmark: pgfId-7797691]> configure user access jdoe basic 
    
 
    [bookmark: pgfId-7797692]where username specifies the name of the user for which you want to modify access, basic indicates basic access, and config indicates configuration access.
 
   
 
    
     [bookmark: pgfId-7797693]add
 
    [bookmark: pgfId-7797694]Creates a new user with the specified name and access level. This command prompts for the user’s password.
 
    [bookmark: pgfId-7903132]Syntax
 
     
     [bookmark: pgfId-7797696]configure user add username [basic | config] 
    
 
    [bookmark: pgfId-7797697]where username specifies the name of the new user, basic indicates basic access, and config indicates configuration access.
 
    [bookmark: pgfId-7905744]Example
 
     
     [bookmark: pgfId-7797699]> configure user add jdoe basic 
    
 
     
     [bookmark: pgfId-7797700]Enter new password for user jdoe: 
    
 
     
     [bookmark: pgfId-7797701]Confirm new password for user jdoe: 
    
 
   
 
    
     [bookmark: pgfId-7797702]aging
 
    [bookmark: pgfId-7797703]Forces the expiration of the user’s password.
 
    [bookmark: pgfId-7903152]Syntax
 
     
     [bookmark: pgfId-7797705]configure user aging username max_days warn_days 
    
 
    [bookmark: pgfId-7797706]where username specifies the name of the user, max_days indicates the maximum number of days that the password is valid, and warn_days indicates the number of days that the user is given to change the password before it expires.
 
    [bookmark: pgfId-7905760]Example
 
     
     [bookmark: pgfId-7797708]> configure user aging jdoe 100 3 
    
 
   
 
    
     [bookmark: pgfId-7797709]delete
 
    [bookmark: pgfId-7797710]Deletes the user and the user’s home directory.
 
    [bookmark: pgfId-7903172]Syntax
 
     
     [bookmark: pgfId-7797712]configure user delete username 
    
 
    [bookmark: pgfId-7797713]where username specifies the name of the user.
 
    [bookmark: pgfId-7905772]Example
 
     
     [bookmark: pgfId-7797716]> configure user delete jdoe 
    
 
   
 
    
     [bookmark: pgfId-7797717]disable
 
    [bookmark: pgfId-7797718]Disables the user. Disabled users cannot login.
 
    [bookmark: pgfId-7903192]Syntax
 
     
     [bookmark: pgfId-7797720]configure user disable username 
    
 
    [bookmark: pgfId-7797721]where username specifies the name of the user.
 
    [bookmark: pgfId-7905784]Example
 
     
     [bookmark: pgfId-7797723]> configure user disable jdoe 
    
 
   
 
    
     [bookmark: pgfId-7797724]enable
 
    [bookmark: pgfId-7797725]Enables the user.
 
    [bookmark: pgfId-7903208]Syntax
 
     
     [bookmark: pgfId-7797727]configure user enable username 
    
 
    [bookmark: pgfId-7797728]where username specifies the name of the user.
 
    [bookmark: pgfId-7905796]Example
 
     
     [bookmark: pgfId-7797730]> configure user enable jdoe  
    
 
   
 
    
     [bookmark: pgfId-7797731]forcereset
 
    [bookmark: pgfId-7797732]Forces the user to change their password the next time they login. When the user logs in and changes the password, strength checking is automatically enabled.
 
    [bookmark: pgfId-7903224]Syntax
 
     
     [bookmark: pgfId-7797734]configure user forcereset username 
    
 
    [bookmark: pgfId-7797735]where username specifies the name of the user.
 
    [bookmark: pgfId-7905808]Example
 
     
     [bookmark: pgfId-7797737]> configure user forcereset jdoe 
    
 
   
 
    
     [bookmark: pgfId-7797738]maxfailedlogins
 
    [bookmark: pgfId-7797739]Sets the maximum number of failed logins for the specified user.
 
    [bookmark: pgfId-7903255]Syntax
 
     
     [bookmark: pgfId-7797741]configure user maxfailedlogins username number 
    
 
    [bookmark: pgfId-7797742]where username specifies the name of the user and number specifies the maximum number of failed logins.
 
    [bookmark: pgfId-7905824]Example
 
     
     [bookmark: pgfId-7797744]> configure user maxfailedlogins jdoe 3 
    
 
   
 
    
     [bookmark: pgfId-7797745]password
 
    [bookmark: pgfId-7797746]Sets the user’s password. This command prompts for the user’s password.
 
    [bookmark: pgfId-7903283]Syntax
 
     
     [bookmark: pgfId-7797748]configure user password username 
    
 
    [bookmark: pgfId-7797749]where username specifies the name of the user.
 
    [bookmark: pgfId-7905836]Example
 
     
     [bookmark: pgfId-7797751]> configure user pasword jdoe 
    
 
     
     [bookmark: pgfId-7797752]Enter new password for user jdoe: 
    
 
     
     [bookmark: pgfId-7797753]Confirm new password for user jdoe: 
    
 
   
 
    
     [bookmark: pgfId-7797754]strengthcheck
 
    [bookmark: pgfId-7797755]Enables or disables the strength requirement for a user’s password. When a user’s password expires or if the configure user forcereset command is used, this requirement is automatically enabled the next time the user logs in.
 
    [bookmark: pgfId-7903311]Syntax
 
     
     [bookmark: pgfId-7797757]configure user strengthcheck username {enable | disable} 
    
 
    [bookmark: pgfId-7797758]where username specifies the name of the user, enable sets the requirement for the specified users password, and disable removes the requirement for the specified user’s password.
 
    [bookmark: pgfId-7905848]Example
 
     
     [bookmark: pgfId-7797760]> configure user strengthcheck jdoe enable 
    
 
   
 
    
     [bookmark: pgfId-7797761]unlock
 
    [bookmark: pgfId-7797762]Unlocks a user that has exceeded the maximum number of failed logins.
 
    [bookmark: pgfId-7903339]Syntax
 
     
     [bookmark: pgfId-7797764]configure user unlock username 
    
 
    [bookmark: pgfId-7797765]where username specifies the name of the user.
 
    [bookmark: pgfId-7905860]Example
 
     
     [bookmark: pgfId-7797767]> configure user unlock jdoe 
    
 
   
 
    
     [bookmark: pgfId-7922293][bookmark: 51523]vmware-tools
 
    [bookmark: pgfId-7931290]Enables or disables VMware Tools functionality on a virtual device. This command is available only on virtual devices.
 
    [bookmark: pgfId-7931311]VMware Tools is a suite of utilities intended to enhance the performance of the virtual machine. These utilities allow you to make full use of the convenient features of VMware products. The system supports the following plugins on all virtual appliances:
 
     
     	 [bookmark: pgfId-7931298]guestInfo
 
     	 [bookmark: pgfId-7931299]powerOps
 
     	 [bookmark: pgfId-7943194]snapshot
 
     	 [bookmark: pgfId-7922307]timeSync
 
     	 [bookmark: pgfId-7922308]vmbackup
 
    
 
    [bookmark: pgfId-7922315]For more information about VMware Tools and the supported plugins, see the VMware website (http://www.vmware.com).
 
    [bookmark: pgfId-7922317]Access
 
    [bookmark: pgfId-7922318]Basic
 
    [bookmark: pgfId-7922319]Syntax
 
     
     [bookmark: pgfId-7922320]configure vmware-tools (enable | disable) 
    
 
    [bookmark: pgfId-7922321]Example
 
     
     [bookmark: pgfId-7922322]> configure vmware-tools enable 
    
 
   
 
    
     [bookmark: pgfId-7774119][bookmark: 13271]System Commands
 
    [bookmark: pgfId-7774175]The system commands enable the user to manage system-wide files and access control settings. Only users with configuration CLI access can issue commands in system mode.
 
    [bookmark: pgfId-7774864]The following sections describe the system commands:
 
     
     	 [bookmark: pgfId-7774877]access-control
 
     	 [bookmark: pgfId-7774943]disable-http-user-cert
 
     	 [bookmark: pgfId-7774961]file
 
     	 [bookmark: pgfId-7774994]generate-troubleshoot
 
     	 [bookmark: pgfId-7775007]ldapsearch
 
     	 [bookmark: pgfId-7777897]lockdown-sensor
 
     	 [bookmark: pgfId-7837769]nat rollback
 
     	 [bookmark: pgfId-7775021]reboot
 
     	 [bookmark: pgfId-7775032]restart
 
     	 [bookmark: pgfId-7775043]shutdown
 
    
 
     
      [bookmark: pgfId-7774996][bookmark: 15227]access-control
 
     [bookmark: pgfId-7774997]The system access-control commands enable the user to manage the access control configuration on the device.
 
     [bookmark: pgfId-7901008]Access
 
     [bookmark: pgfId-7768432]Configuration
 
    
 
     
      [bookmark: pgfId-7768459]archive
 
     [bookmark: pgfId-7768473]Saves the currently applied access control policy as a text file on /var/common.
 
     [bookmark: pgfId-7903355]Syntax
 
      
      [bookmark: pgfId-7768434]system access-control archive 
     
 
     [bookmark: pgfId-7905872]Example
 
      
      [bookmark: pgfId-7768436]> system access-control archive 
     
 
    
 
     
      [bookmark: pgfId-7822189]clear-rule-counts
 
     [bookmark: pgfId-7822190]Resets the access control rule hit count to 0.
 
     [bookmark: pgfId-7903371]Syntax
 
      
      [bookmark: pgfId-7822192]system access-control clear-rule-counts 
     
 
     [bookmark: pgfId-7905884]Example
 
      
      [bookmark: pgfId-7822194]> system access-control clear-rule-counts 
     
 
    
 
     
      [bookmark: pgfId-7768525]rollback
 
     [bookmark: pgfId-7768526]Reverts the system to the previously applied access control configuration. You cannot use this command with clustered or stacked devices.
 
     [bookmark: pgfId-7903387]Syntax
 
      
      [bookmark: pgfId-7768528]system access-control rollback 
     
 
     [bookmark: pgfId-7905900]Example
 
      
      [bookmark: pgfId-7768530]> system access-control rollback 
     
 
    
 
     
      [bookmark: pgfId-7768416][bookmark: 55396]disable-http-user-cert
 
     [bookmark: pgfId-7768306]Removes all HTTP user certification present on the system.
 
     [bookmark: pgfId-7901020]Access
 
     [bookmark: pgfId-7768308]Configuration
 
     [bookmark: pgfId-7903399]Syntax
 
      
      [bookmark: pgfId-7768310]system disable-http-user-cert 
     
 
     [bookmark: pgfId-7905918]Example
 
      
      [bookmark: pgfId-7768312]> system disable-http-user-cert  
     
 
    
 
     
      [bookmark: pgfId-7768287][bookmark: 27630]file
 
     [bookmark: pgfId-7748887]The system file commands enable the user to manage the files in the common directory on the device.
 
     [bookmark: pgfId-7901035]Access
 
     [bookmark: pgfId-7748897]Configuration
 
    
 
     
      [bookmark: pgfId-7748898]copy
 
     [bookmark: pgfId-7748899]Uses FTP to transfer files to a remote location on the host using the login username. The local files must be located in the common directory.
 
     [bookmark: pgfId-7903411]Syntax
 
      
      [bookmark: pgfId-7748901]system file copy hostname username path filenames filenames ... 
     
 
     [bookmark: pgfId-7748995]where hostname specifies the name or ip address of the target remote host, username specifies the name of the user on the remote host, path specifies the destination path on the remote host, and filenames specifies the local files to transfer; the file names are space-separated.
 
     [bookmark: pgfId-7905930]Example
 
      
      [bookmark: pgfId-7748996]> system file copy sfrocks jdoe /pub * 
     
 
    
 
     
      [bookmark: pgfId-7748940]delete
 
     [bookmark: pgfId-7748941]Removes the specified files from the common directory.
 
     [bookmark: pgfId-7903426]Syntax
 
      
      [bookmark: pgfId-7748943]system file delete filenames filenames ... 
     
 
     [bookmark: pgfId-7749010]where filenames specifies the files to delete; the file names are space-separated.
 
     [bookmark: pgfId-7905942]Example
 
      
      [bookmark: pgfId-7748945]> system file delete * 
     
 
    
 
     
      [bookmark: pgfId-7748932]list
 
     [bookmark: pgfId-7749135]If no file names are specified, displays the modification time, size, and file name for all the files in the common directory. If file names are specified, displays the modification time, size, and file name for files that match the specified file names.
 
     [bookmark: pgfId-7903438]Syntax
 
      
      [bookmark: pgfId-7749136]system file list {filenames filenames ...} 
     
 
     [bookmark: pgfId-7749291]where filenames specifies the files to display; the file names are space-separated.
 
     [bookmark: pgfId-7905954]Example
 
      
      [bookmark: pgfId-7749139]> system file list 
     
 
    
 
     
      [bookmark: pgfId-7749077]secure-copy
 
     [bookmark: pgfId-7749166]Uses SCP to transfer files to a remote location on the host using the login username. The local files must be located in the /var/common directory.
 
     [bookmark: pgfId-7903450]Syntax
 
      
      [bookmark: pgfId-7749168]system file secure-copy hostname username path filenames filenames ... 
     
 
     [bookmark: pgfId-7749169]where hostname specifies the name or ip address of the target remote host, username specifies the name of the user on the remote host, path specifies the destination path on the remote host, and filenames specifies the local files to transfer; the file names are space-separated.
 
     [bookmark: pgfId-7905966]Example
 
      
      [bookmark: pgfId-7749171]> system file secure-copy 10.123.31.1 jdoe /tmp * 
     
 
    
 
     
      [bookmark: pgfId-7768202][bookmark: 23007]generate-troubleshoot
 
     [bookmark: pgfId-7748331]Generates troubleshooting data for analysis by Cisco.
 
     [bookmark: pgfId-7901047]Access
 
     [bookmark: pgfId-7748341]Configuration
 
     [bookmark: pgfId-7903462]Syntax
 
      
      [bookmark: pgfId-7748343]system generate-troubleshoot 
     
 
     [bookmark: pgfId-7748414]This syntax displays a list of optional parameters to specify what troubleshooting data should be displayed.
 
     [bookmark: pgfId-7905978]Example
 
      
      [bookmark: pgfId-7748345]> system generate-troubleshoot  
     
 
    
 
     
      [bookmark: pgfId-7768598][bookmark: 33539]ldapsearch
 
     [bookmark: pgfId-7768599]Enables the user to perform a query of the specified LDAP server. Note that all parameters are required.
 
     [bookmark: pgfId-7901059]Access
 
     [bookmark: pgfId-7768601]Configuration
 
     [bookmark: pgfId-7903474]Syntax
 
      
      [bookmark: pgfId-7768744]system ldapsearch host port baseDN userDN basefilter 
     
 
     [bookmark: pgfId-7768721]where host specifies the LDAP server domain, port specifies the LDAP server port, baseDN specifies the DN (distinguished name) that you want to search under, userDN specifies the DN of the user who binds to the LDAP directory, and basefilter specifies the record or records you want to search for.
 
     [bookmark: pgfId-7905990]Example
 
      
      [bookmark: pgfId-7830733]> system ldapsearch ldap.example.com 389 cn=users,
dc=example,dc=com cn=user1,cn=users,dc=example,dc=com, cn=user2 
     
 
    
 
     
      [bookmark: pgfId-7775126][bookmark: 52887]lockdown-sensor
 
     [bookmark: pgfId-7775127]Removes the expert command and access to the bash shell on the device.
 
      
       
     
 
     
 
      
      [bookmark: pgfId-7775185] 
      Caution This command is irreversible without a hotfix from Support. Use with care. 
       
       
 
      
 
     
 
     [bookmark: pgfId-7901071]Access
 
     [bookmark: pgfId-7775129]Configuration
 
     [bookmark: pgfId-7903486]Syntax
 
      
      [bookmark: pgfId-7775131]system lockdown-sensor 
     
 
     [bookmark: pgfId-7906002]Example
 
      
      [bookmark: pgfId-7775133]> system lockdown-sensor 
     
 
    
 
     
      [bookmark: pgfId-7837684][bookmark: 47527]nat rollback
 
     [bookmark: pgfId-7837685]Reverts the system to the previously applied NAT configuration. This command is not available on virtual devices and ASA FirePOWER devices. You cannot use this command with clustered or stacked devices. 
 
     [bookmark: pgfId-7901083]Access
 
     [bookmark: pgfId-7837687]Configuration
 
     [bookmark: pgfId-7903498]Syntax
 
      
      [bookmark: pgfId-7837689]system nat rollback 
     
 
     [bookmark: pgfId-7906014]Example
 
      
      [bookmark: pgfId-7837679]> system nat rollback 
     
 
    
 
     
      [bookmark: pgfId-7775113][bookmark: 60675]reboot
 
     [bookmark: pgfId-7738364]Reboots the device.
 
     [bookmark: pgfId-7901095]Access
 
     [bookmark: pgfId-7748181]Configuration
 
     [bookmark: pgfId-7903510]Syntax
 
      
      [bookmark: pgfId-7738332]system reboot 
     
 
     [bookmark: pgfId-7906026]Example
 
      
      [bookmark: pgfId-7727666]> system reboot 
     
 
    
 
     
      [bookmark: pgfId-7720654][bookmark: 17236]restart
 
     [bookmark: pgfId-7738296]Restarts the device application.
 
     [bookmark: pgfId-7901107]Access
 
     [bookmark: pgfId-7748201]Configuration
 
     [bookmark: pgfId-7903522]Syntax
 
      
      [bookmark: pgfId-7738283]system restart 
     
 
     [bookmark: pgfId-7906045]Example
 
      
      [bookmark: pgfId-7727686]> system restart 
     
 
    
 
     
      [bookmark: pgfId-7720675][bookmark: 61463]shutdown
 
     [bookmark: pgfId-7738229]Shuts down the device. This command is not available on ASA FirePOWER modules.
 
     [bookmark: pgfId-7901119]Access
 
     [bookmark: pgfId-7748235]Configuration
 
     [bookmark: pgfId-7903534]Syntax
 
      
      [bookmark: pgfId-7738243]system shutdown 
     
 
     [bookmark: pgfId-7906061]Example
 
      
      [bookmark: pgfId-7727701]> system shutdown 
     
 
     [bookmark: pgfId-7715951]
 
    
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-7735646][bookmark: 89960][bookmark: marker-7735645]Security, Internet Access, and Communication Ports 
      
      
 
     
 
 
    [bookmark: pgfId-7735652]To safeguard the Defense Center, you should install it on a protected internal network. Although the Defense Center is configured to have only the necessary services and ports available, you must make sure that attacks cannot reach it (or any managed devices) from outside the firewall.
 
    [bookmark: pgfId-7734878]If the Defense Center and its managed devices reside on the same network, you can connect the management interfaces on the devices to the same protected internal network as the Defense Center. This allows you to securely control the devices from the Defense Center. You can also configure multiple management interfaces to allow the Defense Center to manage and isolate traffic from devices on other networks.
 
    [bookmark: pgfId-7733049]Regardless of how you deploy your appliances, intra-appliance communication is encrypted. However, you must still take steps to ensure that communications between FireSIGHT System appliances cannot be interrupted, blocked, or tampered with; for example, with a distributed denial of service (DDoS) or man-in-the-middle attack.
 
    [bookmark: pgfId-7733056]Also note that specific features of the FireSIGHT System require an Internet connection. By default, all FireSIGHT System appliances are configured to directly connect to the Internet. Additionally, the system requires certain ports remain open for basic intra-appliance communication, for secure appliance access, and so that specific system features can access the local or Internet resources they need to operate correctly.
 
     
      
    
 
    
 
    [bookmark: pgfId-7733066]Tip With the exception of Cisco NGIPS for Blue Coat X-Series, FireSIGHT System appliances support the use of a proxy server. For more information, see Configuring Management Interfaces and http-proxy.
 
     
     
 
    
 
    
 
    [bookmark: pgfId-7733073]For more information, see:
 
     
     	 [bookmark: pgfId-7733077]Internet Access Requirements
 
     	 [bookmark: pgfId-7733081]Communication Ports Requirements
 
    
 
   
 
    
     [bookmark: pgfId-7733083][bookmark: 66695]Internet Access Requirements
 
    [bookmark: pgfId-7733087]By default, FireSIGHT System appliances are configured to directly connect to the Internet on ports 443/tcp (HTTPS) and 80/tcp (HTTP), which are open by default on all FireSIGHT System appliances; see Communication Ports Requirements. Note that most FireSIGHT System appliances support use of a proxy server; see Configuring Management Interfaces. Note also that a proxy server cannot be used for whois access.
 
    [bookmark: pgfId-7733103]To ensure continuity of operations, both Defense Centers in a high availability pair must have Internet access. For specific features, the primary Defense Center contacts the Internet, then shares information with the secondary during the synchronization process. Therefore, if the primary fails, you should promote the secondary to Active as described in Monitoring and Changing High Availability Status.
 
    [bookmark: pgfId-7733110]The following table describes the Internet access requirements of specific features of the FireSIGHT System.
 
     
      [bookmark: pgfId-7733278]
 
      
       
        
        [bookmark: pgfId-7733122]Table E-1 FireSIGHT System Feature Internet Access Requirements 
 
        
        
         
         	 
           
           [bookmark: pgfId-7733130]Feature 
          
  
         	 
           
           [bookmark: pgfId-7733132]Internet access is required to... 
          
  
         	 
           
           [bookmark: pgfId-7733134]Appliances 
          
  
         	 
           
           [bookmark: pgfId-7733136]High Availability Considerations 
          
  
        
 
         
         	[bookmark: pgfId-7733138]dynamic analysis: querying
  
         	[bookmark: pgfId-7733146]Defense Center
  
         	[bookmark: pgfId-7733151]Paired Defense Centers query the cloud for threat scores independently.
  
        
 
         
         	[bookmark: pgfId-7733153]dynamic analysis: submitting
  
         	[bookmark: pgfId-7733155]submit files to the cloud for dynamic analysis.
  
         	[bookmark: pgfId-7733157]Any device except Series 2 and X-Series
  
         	[bookmark: pgfId-7733162]n/a
  
        
 
         
         	[bookmark: pgfId-7733167]FireAMP integration
  
         	[bookmark: pgfId-7733169]receive endpoint-based (FireAMP) malware events from the Cisco cloud.
  
         	[bookmark: pgfId-7733180]Defense Center
  
         	[bookmark: pgfId-7733182]Cloud connections are not synchronized. Configure them on both Defense Centers.
  
        
 
         
         	[bookmark: pgfId-7733187]intrusion rule, VDB, and GeoDB updates
  
         	[bookmark: pgfId-7733189]download or schedule the download of a intrusion rule, GeoDB, or VDB update directly to an appliance.
  
         	[bookmark: pgfId-7733194]Defense Center
  
         	[bookmark: pgfId-7733196]Intrusion rule, GeoDB, and VDB updates are synchronized.
  
        
 
         
         	[bookmark: pgfId-7733198]network-based AMP
  
         	[bookmark: pgfId-7733200]perform malware cloud lookups.
  
         	[bookmark: pgfId-7733205]Defense Center
  
         	[bookmark: pgfId-7733210]Paired Defense Centers perform cloud lookups independently.
  
        
 
         
         	[bookmark: pgfId-7733212]RSS feed dashboard widget
  
         	[bookmark: pgfId-7733214]download RSS feed data from an external source, including Cisco.
  
         	[bookmark: pgfId-7733219]Any except virtual devices and X-Series
  
         	[bookmark: pgfId-7733224]Feed data is not synchronized.
  
        
 
         
         	[bookmark: pgfId-7733226]Security Intelligence filtering
  
         	[bookmark: pgfId-7733228]download Security Intelligence feed data from an external source, including the Intelligence Feed.
  
         	[bookmark: pgfId-7733236]Defense Center
  
         	[bookmark: pgfId-7733240]The primary Defense Center downloads feed data and shares it with the secondary. In case of primary failure, promote the secondary to active.
  
        
 
         
         	[bookmark: pgfId-7733243]system software updates
  
         	[bookmark: pgfId-7733245]download or schedule the download of a system update directly to an appliance.
  
         	[bookmark: pgfId-7733247]Any except virtual devices and X-Series
  
         	[bookmark: pgfId-7733252]System updates are not synchronized.
  
        
 
         
         	[bookmark: pgfId-7733254]URL filtering
  
         	[bookmark: pgfId-7733256]download cloud-based URL category and reputation data for access control, and perform lookups for uncategorized URLs.
  
         	[bookmark: pgfId-7733261]Defense Center
  
         	[bookmark: pgfId-7733265]The primary Defense Center downloads URL filtering data and shares it with the secondary. In case of primary failure, promote the secondary to active.
  
        
 
         
         	[bookmark: pgfId-7733268]whois
  
         	[bookmark: pgfId-7733270]request whois information for an external host.
  
         	[bookmark: pgfId-7733272]Any except virtual devices and X-Series
  
         	[bookmark: pgfId-7733277]Any appliance requesting whois information must have Internet access.
  
        
 
        
      
 
     
 
    
 
   
 
    
     [bookmark: pgfId-7733280][bookmark: 15750]Communication Ports Requirements
 
    [bookmark: pgfId-7733281]FireSIGHT System appliances communicate using a two-way, SSL-encrypted communication channel, which by default uses port 8305/tcp. The system requires this port remain open for basic intra-appliance communication. Other open ports allow:
 
     
     	 [bookmark: pgfId-7733282]access to an appliance’s web interface
 
     	 [bookmark: pgfId-7733283]secure remote connections to an appliance
 
     	 [bookmark: pgfId-7733284]certain features of the system to access the local or Internet resources they need to function correctly
 
    
 
    [bookmark: pgfId-7733285]In general, feature-related ports remain closed until you enable or configure the associated feature. For example, until you connect the Defense Center to a User Agent, the agent communications port (3306/tcp) remains closed. As another example, port 623/udp remains closed on Series 3 appliances until you enable LOM.
 
     
      
    
 
    
 
     
     [bookmark: pgfId-7733295] 
     Caution Do 
     not close an open port until you understand how this action will affect your deployment. 
      
      
 
     
 
    
 
    [bookmark: pgfId-7733296]For example, closing port 25/tcp (SMTP) outbound on a manage device blocks the device from sending email notifications for individual intrusion events (see Configuring External Alerting for Intrusion Rules). As another example, you can disable access to a physical managed device’s web interface by closing port 443/tcp (HTTPS), but this also prevents the device from submitting suspected malware files to the cloud for dynamic analysis.
 
    [bookmark: pgfId-7733300]Note that the system allows you to change some of its communication ports:
 
     
     	 [bookmark: pgfId-7733301]You can specify custom ports for LDAP and RADIUS authentication when you configure a connection between the system and the authentication server; see Identifying the LDAP Authentication Server and Configuring RADIUS Connection Settings.
 
     	 [bookmark: pgfId-7733310]You can change the management port (8305/tcp); see Configuring Management Interfaces. However,  Cisco  strongly recommends that you keep the default setting. If you change the management port, you must change it for all appliances in your deployment that need to communicate with each other.
 
     	 [bookmark: pgfId-7733318]You can use port 32137/tcp to allow upgraded Defense Centers to communicate with the Cisco cloud. However, Cisco recommends you switch to port 443, which is the default for fresh installations of Version 5.3 and later. For more information, see Enabling Cloud Communications.
 
    
 
     
     [bookmark: pgfId-7734177]Port 
    
 
     
     [bookmark: pgfId-7734179]Description 
    
 
     
     [bookmark: pgfId-7734181]Direction 
    
 
     
     [bookmark: pgfId-7734183]Is Open on... 
    
 
     
     [bookmark: pgfId-7734185]To... 
    
 
    [bookmark: pgfId-7734187]22/tcp
 
    [bookmark: pgfId-7734189]SSH/SSL
 
    [bookmark: pgfId-7734191]Bidirectional
 
    [bookmark: pgfId-7734193]Any
 
    [bookmark: pgfId-7734195]allow a secure remote connection to the appliance.
 
    [bookmark: pgfId-7734197]25/tcp
 
    [bookmark: pgfId-7734199]SMTP
 
    [bookmark: pgfId-7734201]Outbound
 
    [bookmark: pgfId-7734203]Any
 
    [bookmark: pgfId-7734205]send email notices and alerts from the appliance.
 
    [bookmark: pgfId-7734207]53/tcp
 
    [bookmark: pgfId-7734209]DNS
 
    [bookmark: pgfId-7734211]Outbound
 
    [bookmark: pgfId-7734213]Any
 
    [bookmark: pgfId-7734215]use DNS.
 
    [bookmark: pgfId-7734217]67/udp
 
    [bookmark: pgfId-7734218]68/udp
 
    [bookmark: pgfId-7734220]DHCP
 
    [bookmark: pgfId-7734222]Outbound
 
    [bookmark: pgfId-7734224]Any except X-Series
 
    [bookmark: pgfId-7734229]use DHCP.
 by default. 
    
 
    [bookmark: pgfId-7734232]80/tcp
 
    [bookmark: pgfId-7734234]HTTP
 
    [bookmark: pgfId-7734236]Outbound
 
    [bookmark: pgfId-7734238]Any except virtual devices and X-Series
 
    [bookmark: pgfId-7734248]
 
    [bookmark: pgfId-7734250]Bidirectional
 
    [bookmark: pgfId-7734255]Defense Center
 
    [bookmark: pgfId-7734257]update custom and third-party Security Intelligence feeds via HTTP.
 
    [bookmark: pgfId-7734258]download URL category and reputation data (port 443 also required).
 
    [bookmark: pgfId-7734260]161/udp
 
    [bookmark: pgfId-7734262]SNMP
 
    [bookmark: pgfId-7734264]Bidirectional
 
    [bookmark: pgfId-7734266]Any except X-Series
 
    [bookmark: pgfId-7734271]allow access to an appliance’s MIBs via SNMP polling.
 
    [bookmark: pgfId-7734273]162/udp
 
    [bookmark: pgfId-7734275]SNMP
 
    [bookmark: pgfId-7734277]Outbound
 
    [bookmark: pgfId-7734279]Any
 
    [bookmark: pgfId-7734281]send SNMP alerts to a remote trap server.
 
    [bookmark: pgfId-7734283]389/tcp
 
    [bookmark: pgfId-7734284]636/tcp
 
    [bookmark: pgfId-7734286]LDAP
 
    [bookmark: pgfId-7734288]Outbound
 
    [bookmark: pgfId-7734290]Any except virtual devices and X-Series
 
    [bookmark: pgfId-7734295]communicate with an LDAP server for external authentication.
 
    [bookmark: pgfId-7734297]389/tcp
 
    [bookmark: pgfId-7734298]636/tcp
 
    [bookmark: pgfId-7734300]LDAP
 
    [bookmark: pgfId-7734302]Outbound
 
    [bookmark: pgfId-7734307]Defense Center
 
    [bookmark: pgfId-7734309]obtain metadata for detected LDAP users.
 
    [bookmark: pgfId-7734311]443/tcp
 
    [bookmark: pgfId-7734313]HTTPS
 
    [bookmark: pgfId-7734315]Inbound
 
    [bookmark: pgfId-7734317]Any except virtual devices and X-Series
 
    [bookmark: pgfId-7734322]access an appliance’s web interface.
 
    [bookmark: pgfId-7734324]443/tcp
 
    [bookmark: pgfId-7734326]HTTPS
 
    [bookmark: pgfId-7734327]AMQP
 
    [bookmark: pgfId-7734328]cloud comms.
 
    [bookmark: pgfId-7734330]Bidirectional
 
    [bookmark: pgfId-7734335]Defense Center
 
    [bookmark: pgfId-7734337]obtain:
 
     
     	 [bookmark: pgfId-7734338]software, intrusion rule, VDB, and GeoDB updates
 
     	 [bookmark: pgfId-7734339]URL category and reputation data (port 80 also required)
 
     	 [bookmark: pgfId-7734343]the Intelligence Feed and other secure Security Intelligence feeds
 
     	 [bookmark: pgfId-7734347]endpoint-based (FireAMP) malware events
 
     	 [bookmark: pgfId-7734348]malware dispositions for files detected in network traffic
 
     	 [bookmark: pgfId-7734349]dynamic analysis information on submitted files
 
    
 
    [bookmark: pgfId-7734351]
 
    [bookmark: pgfId-7734353]
 
    [bookmark: pgfId-7734360]Series 2 and Series 3 devices
 
    [bookmark: pgfId-7734365]download software updates using the device’s local web interface.
 
    [bookmark: pgfId-7734367]
 
    [bookmark: pgfId-7734369]
 
    [bookmark: pgfId-7734376]Series 3 and virtual devices
 
    [bookmark: pgfId-7734381]submit files to for dynamic analysis.
 
    [bookmark: pgfId-7734383]514/udp
 
    [bookmark: pgfId-7734385]syslog 
 
    [bookmark: pgfId-7734387]Outbound
 
    [bookmark: pgfId-7734389]Any
 
    [bookmark: pgfId-7734391]send alerts to a remote syslog server.
 
    [bookmark: pgfId-7734393]623/udp
 
    [bookmark: pgfId-7734395]SOL/LOM
 
    [bookmark: pgfId-7734397]Bidirectional
 
    [bookmark: pgfId-7734402]Series 3
 
    [bookmark: pgfId-7734404]allow you to perform Lights-Out Management using a Serial Over LAN (SOL) connection.
 
    [bookmark: pgfId-7734406]1500/tcp
 
    [bookmark: pgfId-7734407]2000/tcp
 
    [bookmark: pgfId-7734409]database access
 
    [bookmark: pgfId-7734411]Inbound
 
    [bookmark: pgfId-7734416]Defense Center
 
    [bookmark: pgfId-7734421]allow read-only access to the database by a third-party client.
 
    [bookmark: pgfId-7734423]1812/udp
 
    [bookmark: pgfId-7734424]1813/udp
 
    [bookmark: pgfId-7734426]RADIUS
 
    [bookmark: pgfId-7734428]Bidirectional
 
    [bookmark: pgfId-7734430]Any except virtual devices and X-Series
 
    [bookmark: pgfId-7734435]communicate with a RADIUS server for external authentication and accounting.
 
    [bookmark: pgfId-7734437]3306/tcp
 
    [bookmark: pgfId-7734442]User Agent
 
    [bookmark: pgfId-7734444]Inbound
 
    [bookmark: pgfId-7734449]Defense Center
 
    [bookmark: pgfId-7734454]communicate with User Agents.
 
    [bookmark: pgfId-7734456]8302/tcp
 
    [bookmark: pgfId-7734461]eStreamer
 
    [bookmark: pgfId-7734463]Bidirectional
 
    [bookmark: pgfId-7734465]Any except virtual devices and X-Series
 
    [bookmark: pgfId-7734473]communicate with an eStreamer client.
 
    [bookmark: pgfId-7734475]8305/tcp
 
    [bookmark: pgfId-7734477]appliance comms.
 
    [bookmark: pgfId-7734479]Bidirectional
 
    [bookmark: pgfId-7734481]Any
 
    [bookmark: pgfId-7734483]securely communicate between appliances in a deployment. Required.
 
    [bookmark: pgfId-7734485]8307/tcp
 
    [bookmark: pgfId-7734487]host input client
 
    [bookmark: pgfId-7734489]Bidirectional
 
    [bookmark: pgfId-7734494]Defense Center
 
    [bookmark: pgfId-7734496]communicate with a host input client.
 
    [bookmark: pgfId-7734498]32137/tcp
 
    [bookmark: pgfId-7734500]cloud comms.
 
    [bookmark: pgfId-7734502]Bidirectional
 
    [bookmark: pgfId-7734507]Defense Center
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-1219979][bookmark: 41076]Third-Party Products 
      
      
 
     
 
 
     
      
       
       [bookmark: pgfId-1242959]Table F-1 Open Source Software Licensing 
 
       
       
        
        	 
          
          [bookmark: pgfId-1242963]Open Source Software 
         
  
        	 
          
          [bookmark: pgfId-1242965]License Agreement 
         
  
       
 
        
        	[bookmark: pgfId-1242967]Apache HTTPD Web Server 2.4.3
  
        	[bookmark: pgfId-1242969]Apache License
  
       
 
        
        	[bookmark: pgfId-1245518]Linux Kernel 2.6.32.24 (Series 2)
  
        	[bookmark: pgfId-1245520]GNU General Public License Version 2 (GPLv2)
  
       
 
        
        	[bookmark: pgfId-1245632]Linux Kernel 2.6.35.14 (Series 3)
  
        	[bookmark: pgfId-1245634]GNU General Public License Version 2 (GPLv2)
  
       
 
        
        	[bookmark: pgfId-1242975]Perl 5.10.1 and related modules 
  
        	[bookmark: pgfId-1242977]Perl Artistic License
  
       
 
        
        	[bookmark: pgfId-1242979]Snort 2.9.7
  
        	[bookmark: pgfId-1242981]GNU General Public License Version 2 (GPLv2)
  
       
 
       
     
 
    
 
    [bookmark: pgfId-1243204]A complete list of all third-party open source code products and the full text of all applicable license agreements that are distributed with the FireSIGHT System products can be obtained by logging into the product command line and viewing the following:
 
     
     [bookmark: pgfId-1243254]/usr/share/license-files 
    
 
    [bookmark: pgfId-1243206]If you would like to receive the source code to any of the third-party open source code products used in combination with the FireSIGHT System products, you may do so by submitting a request to the Support Site.
 
    [bookmark: pgfId-1243741]
 
   
 
  
 
  
  
   
   
    
     [bookmark: pgfId-2760125]Glossary
 
     
     [bookmark: pgfId-2764070] 
     [bookmark: 53632]7000 Series 
    
 
     
     [bookmark: pgfId-2809359]A group of 
     Series 3 
     managed devices. The devices in this series include the 70xx Family (the 3D7010/7020/7030/7050 models) and the 71xx Family (3D7110/7120/3D7115/3D7125 and AMP7150 models). 
    
 
     
     [bookmark: pgfId-2760448] 
     [bookmark: 11736]8000 Series 
    
 
     
     [bookmark: pgfId-2760281]A group of 
     Series 3 
     managed devices. The devices in this series include the 81xx Family (the 3D8120/8130/8140 and AMP8150 models), the 82xx Family (the 3D8250/8260/8270/8290 models), the 83xx Family (the 3D8350/8360/8370/8390 models), and the AMP83xx Family (the AMP8350/AMP8360/AMP8370/AMP8390 models). 8000 Series devices are generally more powerful than 
     7000 Series devices. 
    
 
     
     [bookmark: pgfId-2760330] 
     [bookmark: 96032]access control 
    
 
     
     [bookmark: pgfId-2760131]A feature of the FireSIGHT System that allows you to specify, inspect, and log the traffic that traverses your network. Access control invokes 
     Security Intelligence, 
     SSL inspection, 
     preprocessor options, 
     intrusion detection and prevention, 
     file control, and 
     advanced malware protection. It also determines the traffic you can inspect with 
     discovery. 
    
 
     
     [bookmark: pgfId-2598407] 
     [bookmark: 93848]access control policy 
    
 
     
     [bookmark: pgfId-2858230]A 
     policy that you 
     apply to managed 
     devices to perform 
     access control on the network traffic monitored by those devices. An access control policy may include multiple 
     access control rules; it also specifies a 
     default action, which determines the handling and logging of traffic that does not meet the criteria of any of those rules. Other settings in the access control policy govern 
     Security Intelligence, 
     SSL inspection, performance options, 
     preprocessor options, and other advanced configurations. 
    
 
     
     [bookmark: pgfId-2598425] 
     [bookmark: 17040]access control rule 
    
 
     
     [bookmark: pgfId-2598429]A set of conditions the FireSIGHT System uses to examine your monitored network traffic and achieve granular 
     access control. Access control rules, which populate an 
     access control policy, may perform simple IP address matching, or may characterize complex 
     connections involving many different criteria. The 
     access control rule action determines how the system handles traffic that meets the rule’s conditions. Other rule settings determine how (and whether) the connection is logged, and whether an 
     intrusion policy or 
     file policy inspects traffic allowed by the rule. 
    
 
     
     [bookmark: pgfId-2598443] 
     [bookmark: 68882]access control rule action 
    
 
     
     [bookmark: pgfId-2658857]A setting that determines how the system handles network traffic that meets the conditions of an 
     access control rule. You can 
      block matching traffic (with or without resetting the 
     connection); for HTTP traffic you can provide users with the option to bypass the block. You can also 
      trust traffic to pass without further inspection, 
      allow matching traffic, which optionally can be inspected with an 
     intrusion policy and 
     file policy, or continue to 
      monitor the traffic with additional access control rules. 
    
 
     
     [bookmark: pgfId-2765113] 
     [bookmark: 54011]access-controlled user 
    
 
     
     [bookmark: pgfId-2765117]A user whose network use you can control using 
     access control. You specify the LDAP groups that access-controlled users must belong to when you configure a connection between a Microsoft Active Directory server and the 
     Defense Center. When the 
     User Agent reports logins by access-controlled users, those users are associated with IP addresses, which in turn allows 
     access control rules with user conditions to trigger. Compare with 
     non-access-controlled user. 
    
 
     
     [bookmark: pgfId-2598451]access list 
    
 
     
     [bookmark: pgfId-2598455]A list of IP addresses, configured in the 
     system policy, that represents the 
     hosts that can access an 
     appliance. By default, anyone can access the web interface of an appliance using port 443 (HTTPS), as well as the command line using port 22 (SSH). You can also add SNMP access using port 161. 
    
 
     
     [bookmark: pgfId-2858629] 
     [bookmark: 29938]action 
    
 
     
     [bookmark: pgfId-2858637]A setting that determines how the system handles, inspects, or logs network traffic that meets (or does not meet) certain criteria. Actions are associated with various types of 
     rule, as well as with certain policies as the policy’s 
     default action. 
    
 
     
     [bookmark: pgfId-2598456] 
     [bookmark: 95893]active detection 
    
 
     
     [bookmark: pgfId-2598457]The discovery of 
     host, 
     application, and 
     user information using active sources. Active sources include scanners such as 
     Nmap, user input to the system’s web interface, or 
     host input to the 
     network map using the command line or third-party application API calls. Compare with 
     passive detection. 
    
 
     
     [bookmark: pgfId-2598470] 
     [bookmark: 49844]adaptive profile 
    
 
     
     [bookmark: pgfId-2598474]Recommended for passive deployments, an advanced 
     access control policy setting that uses 
     discovery data to determine the operating system for the target 
     host of a packet. Targeted profiles within network analysis policies then defragment IP packets and reassemble streams in the same way as the operating system on the target host. Intrusion policies then analyze the data in the same format as that used by the destination host. 
    
 
     
     [bookmark: pgfId-2704508] 
     [bookmark: 21877]advanced malware protection 
    
 
     
     [bookmark: pgfId-2707999]Abbreviated AMP, the FireSIGHT System’s network-based 
     malware detection and 
     malware blocking feature. Compare this functionality with 
     FireAMP, Cisco’s endpoint-based AMP tool that requires a 
     FireAMP subscription. 
    
 
     
     [bookmark: pgfId-2598487] 
     [bookmark: 16271]alert 
    
 
     
     [bookmark: pgfId-2598488]A notification that the system has generated a specific 
     event. You can alert based on 
     intrusion events (including their 
     impacts), 
     discovery events, network-based 
     malware events, 
     correlation policy violations, health status changes, and logged 
     connections. In most cases, you can alert via email, syslog, or SNMP trap. 
    
 
     
     [bookmark: pgfId-2598492]alert response 
    
 
     
     [bookmark: pgfId-2598496]A set of configurations that allows the system to send an 
     alert via email, syslog, or SNMP trap. You can use a single alert response to alert you to multiple types of 
     events. 
    
 
     
     [bookmark: pgfId-2598498] 
     [bookmark: 36482]appliance 
    
 
     
     [bookmark: pgfId-2598502]A FireSIGHT System 
     Defense Center, managed 
     device, 
     Cisco ASA with FirePOWER Services, or 
     Cisco NGIPS for Blue Coat X-Series. An appliance can be physical or software-based. 
    
 
     
     [bookmark: pgfId-2598503]appliance statistics 
    
 
     
     [bookmark: pgfId-2598507]Information you can obtain about an 
     appliance, including uptime, system memory usage, load average, disk usage, a summary of system processes, and, on the 
     Defense Center, information about 
     data correlator processes. 
    
 
     
     [bookmark: pgfId-2598515] 
     [bookmark: 13076]application 
    
 
     
     [bookmark: pgfId-2626680]A detected network asset, communications method, or HTTP content. The system detects three types of application: 
     application protocol, 
     client application, and 
     web application. 
    
 
     
     [bookmark: pgfId-2875199]application business relevance 
    
 
     
     [bookmark: pgfId-2875203]See 
     business relevance. 
    
 
     
     [bookmark: pgfId-2875205] 
     [bookmark: 11181]application category 
    
 
     
     [bookmark: pgfId-2875209]A general classification for an 
     application that describes its most essential function. Each application belongs to at least one category. 
    
 
     
     [bookmark: pgfId-2598531] 
     [bookmark: 49274]application control 
    
 
     
     [bookmark: pgfId-2598535]A feature that, as part of 
     access control, allows you to specify which 
     application traffic can traverse your network. 
    
 
     
     [bookmark: pgfId-2598539] 
     [bookmark: 87251]application detector 
    
 
     
     [bookmark: pgfId-2598540]A tool that the system uses to identify 
     applications on your network. Application detectors identify applications using ASCII or hexadecimal patterns in the packet headers, the port that the traffic uses, or both. Cisco may deliver additional detectors via system update, 
     vulnerability database update, or the 
     import/ 
     export feature. You can also create your own 
     application protocol detectors. 
    
 
     
     [bookmark: pgfId-2598547] 
     [bookmark: 82086]application filter 
    
 
     
     [bookmark: pgfId-2628065]One or more 
     applications grouped according to criteria associated with the application 
     risk, 
     business relevance, type, categories, and tags. You create application filters in the 
     object manager. 
    
 
     
     [bookmark: pgfId-2598550] 
     [bookmark: 69830]application protocol 
    
 
     
     [bookmark: pgfId-2598551]A type of 
     application that represents application protocol traffic detected during communications between server and 
     client applications on hosts; for example, SSH or HTTP. 
    
 
     
     [bookmark: pgfId-2598552] 
     [bookmark: 28078]application risk 
    
 
     
     [bookmark: pgfId-2598553]The likelihood that an 
     application’s use may violate your organization’s 
     security policy. An application’s risk can range from very low to very high. 
    
 
     
     [bookmark: pgfId-2598554] 
     [bookmark: 33699]application tag 
    
 
     
     [bookmark: pgfId-2598558]Information about an 
     application that is not covered by its 
     application category. For example, video streaming 
     web applications often are tagged “high bandwidth” and “displays ads.” An application may have any number of tags, including none. 
    
 
     
     [bookmark: pgfId-2598559]application type 
    
 
     
     [bookmark: pgfId-2598568]Whether an 
     application is an 
     application protocol, 
     client application, or 
     web application. 
    
 
     
     [bookmark: pgfId-2598570] 
     [bookmark: 97168]apply 
    
 
     
     [bookmark: pgfId-2598571]The action you take to have a 
     policy, or changes to that policy, take effect. You apply most policies from the 
     Defense Center to its managed 
     devices; however, you activate and deactivate 
     correlation policies because they do not involve changes to the configuration of managed devices. 
    
 
     
     [bookmark: pgfId-2819210]ASA FirePOWER 
    
 
     
     [bookmark: pgfId-2819557]The short name for 
     Cisco ASA with FirePOWER Services. 
    
 
     
     [bookmark: pgfId-2598575] 
     [bookmark: 62369]audit event 
    
 
     
     [bookmark: pgfId-2598582]An 
     event that describes a specific FireSIGHT System user interaction. Each audit event contains a time stamp, the user name of the user whose action generated the event, a source IP address, and text describing the event. Audit events are recorded in the 
     audit log. 
    
 
     
     [bookmark: pgfId-2598586] 
     [bookmark: 21575]audit log 
    
 
     
     [bookmark: pgfId-2598587]A record of user interactions with the system. The audit log comprises 
     audit events. 
    
 
     
     [bookmark: pgfId-2598591] 
     [bookmark: 76177]authentication object 
    
 
     
     [bookmark: pgfId-2858749]A collection of settings that allows you to connect to an external authentication server to enable 
     external authentication (RADIUS or LDAP) to the FireSIGHT System’s web interface. 
    
 
     
     [bookmark: pgfId-2858763] 
     [bookmark: 87056]automatic application bypass (AAB) 
    
 
     
     [bookmark: pgfId-2598611]An advanced 
     device setting that limits the time allowed to process packets through an interface and allows packets to bypass processing if the time is exceeded. 
    
 
     
     [bookmark: pgfId-2622142]banner 
    
 
     
     [bookmark: pgfId-2622143]See 
     server banner. 
    
 
     
     [bookmark: pgfId-2622144] 
     [bookmark: 30566]base policy 
    
 
     
     [bookmark: pgfId-2598621]An 
     intrusion policy or 
     network analysis policy that serves as the 
     base policy layer for a custom policy. 
    
 
     
     [bookmark: pgfId-2598628] 
     [bookmark: 13175]base policy layer 
    
 
     
     [bookmark: pgfId-2598638]The lowest, 
     built-in layer in an 
     intrusion policy or 
     network analysis policy. The 
     base policy determines the settings in the base policy layer, and thus the default settings for the policy. 
    
 
     
     [bookmark: pgfId-2666162] 
     [bookmark: 88433]blacklist 
    
 
     
     [bookmark: pgfId-2666166]See 
     health monitor blacklist or 
     Security Intelligence blacklist. 
    
 
     
     [bookmark: pgfId-2598639]bookmark 
    
 
     
     [bookmark: pgfId-2598640]A saved link to a specific location and time in an 
     event analysis. Bookmarks retain information about the 
     workflow you are using, the part of the workflow you are viewing, the page number within the workflow you are viewing, the 
     time window you selected, and any columns you disabled, as well as any constraints you imposed. 
    
 
     
     [bookmark: pgfId-2598647] 
     [bookmark: 51140]built-in layer 
    
 
     
     [bookmark: pgfId-2598651]A read-only 
     layer in an 
     intrusion policy or 
     network analysis policy. These policies always include a built-in 
     base policy layer; intrusion policies can also include a built-in 
     FireSIGHT Recommendations layer. 
    
 
     
     [bookmark: pgfId-2598658] 
     [bookmark: 53289]business relevance 
    
 
     
     [bookmark: pgfId-2598659]The likelihood that an 
     application is used within the context of your organization’s business operations, as opposed to recreationally. An application’s business relevance can range from very low to very high. 
    
 
     
     [bookmark: pgfId-2753672] 
     [bookmark: 95895]bypass mode 
    
 
     
     [bookmark: pgfId-2753676]A characteristic of an 
     inline set that allows traffic to continue flowing if the 
     sensing interfaces in the set fail for any reason. 
    
 
     
     [bookmark: pgfId-2853750]CA 
    
 
     
     [bookmark: pgfId-2853754]See 
     certificate authority. 
    
 
     
     [bookmark: pgfId-2853761] 
     [bookmark: 23696]CAC authentication and authorization 
    
 
     
     [bookmark: pgfId-2853768]A type of 
     LDAP authentication that allows users to log in to the web interface of an 
     appliance using only the credentials provided by a 
     Common Access Card (CAC). 
    
 
     
     [bookmark: pgfId-2805309] 
     [bookmark: 63625]captured file 
    
 
     
     [bookmark: pgfId-2805414]A file detected in network traffic that a device copies, either for submission to the 
     Collective Security Intelligence Cloud for 
     dynamic analysis or 
     Spero analysis, or for 
     file storage to the device. 
    
 
     
     [bookmark: pgfId-2753657]category 
    
 
     
     [bookmark: pgfId-2823803]See 
     application category, 
     file category, or 
     URL category. 
    
 
     
     [bookmark: pgfId-2853773]certificate 
    
 
     
     [bookmark: pgfId-2853777]See 
     public key certificate. 
    
 
     
     [bookmark: pgfId-2823806] 
     [bookmark: 76238]certificate authority 
    
 
     
     [bookmark: pgfId-2644204]The certificate issuer used to create 
     server certificates or user 
     public key certificates. Server and user certificates provide an additional confirmation of a server or a user identity. 
    
 
     
     [bookmark: pgfId-2598671] 
     [bookmark: 97523]certificate revocation list (CRL) 
    
 
     
     [bookmark: pgfId-2598672]A list of certificates revoked by the 
     certificate authority that issued the user certificates for your 
     appliance. This allows you to restrict access to the FireSIGHT System web interface using client browser certificate checking. If the user selects a certificate that is listed in the CRL as a revoked certificate, the browser cannot load the web interface. During 
     SSL inspection, a 
     device can detect a 
     public key certificate on a CRL and not trust the encrypted traffic. 
    
 
     
     [bookmark: pgfId-2788151]change reconciliation report 
    
 
     
     [bookmark: pgfId-2852672]A detailed report of all system changes in the last 24 hours, based on snapshots taken whenever a new configuration is saved. You can configure the system to email these reports daily at a time that you specify. 
    
 
     
     [bookmark: pgfId-2864269] 
     [bookmark: 35750]cipher suite list 
    
 
     
     [bookmark: pgfId-2864289]A reusable 
     object that represents multiple cipher suites used to encrypt traffic. 
    
 
     
     [bookmark: pgfId-2820073] 
     [bookmark: 47418]Cisco ASA with FirePOWER Services 
    
 
     
     [bookmark: pgfId-2820182]A group of Cisco Adaptive Security Appliance (ASA) 
     managed devices with an ASA FirePOWER module installed. The devices in this series include the ASA5506-X, ASA5506H-X, ASA5506W-X, ASA5508-X, ASA5512-X, ASA5515-X, ASA5516-X, ASA5525-X, ASA5545-X, ASA5555-X, ASA5585-X-SSP-10, ASA5585-X-SSP-20, ASA5585-X-SSP-40, and ASA5585-X-SSP-60 models. 
    
 
     
     [bookmark: pgfId-2875235]Cisco Cloud 
    
 
     
     [bookmark: pgfId-2875248]See 
     Collective Security Intelligence Cloud. 
    
 
     
     [bookmark: pgfId-2855196] 
     [bookmark: 59558]Cisco NGIPS for Blue Coat X-Series 
    
 
     
     [bookmark: pgfId-2855188]A software-based application built on Blue Coat’s scalable chassis-based system that provides most of the capabilities of a 
     virtual device. 
    
 
     
     [bookmark: pgfId-2818498] 
     [bookmark: 76968]Cisco VRT 
    
 
     
     [bookmark: pgfId-2818502]Cisco’s Vulnerability Research Team. 
    
 
     
     [bookmark: pgfId-2803622] 
     [bookmark: 54099]clean list 
    
 
     
     [bookmark: pgfId-2803626]A list of files as represented by their 
     SHA-256 hash values. When the system detects a file in the list, it does not perform a 
     malware cloud lookup, treating the file as clean, even if the 
     disposition for the file in the 
     Collective Security Intelligence Cloud is Malware. 
    
 
     
     [bookmark: pgfId-2598679] 
     [bookmark: 19368]CLI 
    
 
     
     [bookmark: pgfId-2598683]See 
     command line interface (CLI). 
    
 
     
     [bookmark: pgfId-2598685] 
     [bookmark: 53991]client 
    
 
     
     [bookmark: pgfId-2598689]Also called a client application, an 
     application that runs on one 
     host and relies on another host (a 
     server) to perform some operation. For example, email clients allow you to send and receive email. When the system detects that a user on a host is using a specific client to access another host, it reports that information in the 
     host profile and 
     network map, including the name and version (if available) of the client. 
    
 
     
     [bookmark: pgfId-2598697] 
     [bookmark: 88110]client application 
    
 
     
     [bookmark: pgfId-2598701]See 
     client. 
    
 
     
     [bookmark: pgfId-2598702]clipboard 
    
 
     
     [bookmark: pgfId-2610062]A holding area where you can copy up to 25,000 
     intrusion events that you can later add to 
     incidents. 
    
 
     
     [bookmark: pgfId-2658986]cloud services 
    
 
     
     [bookmark: pgfId-2694352]See 
     Collective Security Intelligence Cloud. 
    
 
     
     [bookmark: pgfId-2598716] 
     [bookmark: 99003]clustering 
    
 
     
     [bookmark: pgfId-2788629]A feature that allows you to achieve redundancy of networking functionality and configuration data between two peer 
     Series 3 
     devices or 
     stacks. Clustering provides a single logical system for 
     policy applies, system updates, and registration. Compare with 
     high availability, which allows you to configure redundant 
     Defense Centers. 
    
 
     
     [bookmark: pgfId-2852629] 
     [bookmark: 70201]Collective Security Intelligence Cloud 
    
 
     
     [bookmark: pgfId-2852637]Sometimes called 
      cloud services or the 
      Cisco cloud , a Cisco-hosted server where the 
     Defense Center can obtain up-to-date, relevant information including malware, 
     Security Intelligence, and 
     URL filtering data. See also 
     malware cloud lookup and 
     FireAMP Private Cloud. 
    
 
     
     [bookmark: pgfId-2852632] 
     [bookmark: 41053]command line interface (CLI) 
    
 
     
     [bookmark: pgfId-2733732]A restricted text-based interface on 
     Series 3 and 
     virtual devices. The commands that CLI users can run depend on the users’ assigned level of access. 
    
 
     
     [bookmark: pgfId-2854136] 
     [bookmark: 88215]Common Access Card (CAC) 
    
 
     
     [bookmark: pgfId-2854140]A United States Department of Defense-issued identification card used for 
     CAC authentication and authorization. 
    
 
     
     [bookmark: pgfId-2598727]complex constraint 
    
 
     
     [bookmark: pgfId-2598728]A constraint set in an 
     event view or event search that constrains an event query using all the criteria from a specific event. 
    
 
     
     [bookmark: pgfId-2598730] 
     [bookmark: 79060]compliance white list 
    
 
     
     [bookmark: pgfId-2598734]Along with 
     correlation rules, one of the ways you can specify criteria that network traffic must meet in order to violate a 
     correlation policy. You can use the 
     Defense Center to configure compliance white lists to specify which operating systems, 
     applications, and protocols are allowed to run on the 
     hosts in a specific subnet. You can also configure the Defense Center to launch a response, such as an 
     alert or 
     remediation, when a white list is violated. Note that compliance white lists are not associated with the other types of 
     whitelist. 
    
 
     
     [bookmark: pgfId-2598756]compliance white list event 
    
 
     
     [bookmark: pgfId-2598760]See 
     white list event. 
    
 
     
     [bookmark: pgfId-2598761]compliance white list violation 
    
 
     
     [bookmark: pgfId-2598765]See 
     white list violation. 
    
 
     
     [bookmark: pgfId-2753702] 
     [bookmark: 77296]configurable bypass 
    
 
     
     [bookmark: pgfId-2753795]A characteristic of an 
     inline set that allows you to configure 
     bypass mode. 
    
 
     
     [bookmark: pgfId-2811235]configuration, for import or export 
    
 
     
     [bookmark: pgfId-2811242]A set of configurations, such as a 
     policy or 
     custom workflow, that is created on an 
     appliance and can be 
     exported from that appliance and 
     imported by another appliance. 
    
 
     
     [bookmark: pgfId-2598767] 
     [bookmark: 63256]connection 
    
 
     
     [bookmark: pgfId-2598768]A monitored session between two 
     hosts. You can log connections detected by FireSIGHT System managed 
     devices as well as import connection data from 
     NetFlow-enabled devices. 
    
 
     
     [bookmark: pgfId-2598770] 
     [bookmark: 20902]connection event 
    
 
     
     [bookmark: pgfId-2859726]An 
     event generated when the system detects a 
     connection between a monitored 
     host and any other host. 
     Security Intelligence events are a special kind of connection event. Connection events include information about the detected traffic. Various settings give you granular control over which connections you log, when you log them, and where you store the data. For connections detected by managed 
     devices, you can log unblocked connections at their beginning and end, but most blocked connections at their beginning only. You can log these connections to the 
     Defense Center database; depending on the rule or default action, you can also log connection events to an external syslog or SNMP trap server. 
     NetFlow records log the ends of connections and are always saved to the database. 
    
 
     
     [bookmark: pgfId-2598778] 
     [bookmark: 76968]connection graph 
    
 
     
     [bookmark: pgfId-2598779]A way of displaying 
     connection events in graphical form. 
    
 
     
     [bookmark: pgfId-2598780]connection log 
    
 
     
     [bookmark: pgfId-2598784]See 
     connection event. 
    
 
     
     [bookmark: pgfId-2598785]connection summary 
    
 
     
     [bookmark: pgfId-2768864]Connection data aggregated over a five-minute interval. The system uses connection summaries to build 
     connection graphs and 
     traffic profiles. To be aggregated, multiple 
     connections must represent the end of connections, have the same source and destination IP addresses, and use the same port on the responder (destination) 
     host. They must use the same protocol (TCP or UDP) and 
     application protocol. Finally, they must either be detected by the same managed 
     device, or be exported by the same 
     NetFlow-enabled device. 
    
 
     
     [bookmark: pgfId-2598790] 
     [bookmark: 98222]connection tracker 
    
 
     
     [bookmark: pgfId-2598794]One or more conditions that constrain a 
     correlation rule so that after the rule’s initial criteria are met, the system begins tracking certain 
     connections. The rule then triggers only if the tracked connections meet additional criteria. 
    
 
     
     [bookmark: pgfId-2695834] 
     [bookmark: 13032]Context Explorer 
    
 
     
     [bookmark: pgfId-2743379]A page that displays detailed, interactive graphical information about your monitored network. Distinct sections present information in the form of vivid line, bar, pie, and donut graphs, accompanied by detailed lists. You can easily create and apply custom filters to fine-tune your analysis, and you can examine data sections in more detail by clicking or hovering your cursor over graph areas. Compared with a 
     dashboard, which is highly customizable, compartmentalized, and updates in real time, the Context Explorer is manually updated, designed to provide broader context for its data, and has a single, consistent layout designed for active user exploration. 
    
 
     
     [bookmark: pgfId-2769199] 
     [bookmark: 56074]context menu 
    
 
     
     [bookmark: pgfId-2789583]A pop-up menu, available on many of the pages in the web interface, that you can use as a shortcut for accessing other features in the FireSIGHT System. The contents of the menu depend on several factors, including the page you are viewing, the specific data you are investigating, and your 
     user role. 
    
 
     
     [bookmark: pgfId-2743395] 
     [bookmark: 66643]Control license 
    
 
     
     [bookmark: pgfId-2743402]A license that allows you to implement 
     user control and 
     application control. It also allows you to configure supported managed 
     devices to perform hardware-based tasks such as switching and routing (including DHCP relay and 
     NAT), 
     VPN, and device 
     clustering. 
    
 
     
     [bookmark: pgfId-2598797] 
     [bookmark: 71263]correlation 
    
 
     
     [bookmark: pgfId-2598801]A feature you can use to build a 
     correlation policy that responds in real time to threats on your network. The 
     remediation component of correlation provides a flexible API that allows you to create and upload your own custom remediation modules to respond to 
      policy violations. 
    
 
     
     [bookmark: pgfId-2598808] 
     [bookmark: 56972]correlation event 
    
 
     
     [bookmark: pgfId-2598818]An 
     event generated by the 
     Defense Center when a 
     correlation rule triggers. Note that 
     white list events, generated by 
     white list violations, are a special kind of correlation event. 
    
 
     
     [bookmark: pgfId-2598825] 
     [bookmark: 54947]correlation policy 
    
 
     
     [bookmark: pgfId-2598829]A policy that describes the network activity that constitutes a 
     security policy violation, using 
     correlation rules and 
     compliance white lists. You can specify 
     responses to each rule or white list within a policy. 
    
 
     
     [bookmark: pgfId-2598843] 
     [bookmark: 37260]correlation rule 
    
 
     
     [bookmark: pgfId-2633257]With 
     compliance white lists, one of the ways you can specify criteria that network traffic must meet in order to violate a 
     correlation policy. You can use the 
     Defense Center to configure correlation rules to trigger (and generate a 
     correlation event) when a specific event occurs, or when your network traffic deviates from your normal network traffic pattern as characterized in a 
     traffic profile. You can constrain correlation rules with 
     host profile qualifications, 
     connection trackers, 
     snooze periods, and 
     inactive periods. You can also configure the Defense Center to launch a response, such as an 
     alert or 
     remediation, when a correlation rule triggers. 
    
 
     
     [bookmark: pgfId-2598893]CRL 
    
 
     
     [bookmark: pgfId-2598897]See 
     certificate revocation list (CRL). 
    
 
     
     [bookmark: pgfId-2598898]current identity 
    
 
     
     [bookmark: pgfId-2624872]The operating system or 
     server identity that the system finds most likely to be correct for a particular network asset. The system uses this data in many ways; for example, to calculate statistics, assign 
     vulnerability information, assess impact of an attack, and evaluate 
     correlation rules. 
    
 
     
     [bookmark: pgfId-2598906] 
     [bookmark: 54254]current user 
    
 
     
     [bookmark: pgfId-2598907]The user that the system associates with a 
     host. If the user is an 
     access-controlled user, the system can perform 
     user control on traffic to or from that host. If no access-controlled user is associated with the host, a 
     non-access-controlled user can be the current user for the host. However, after an access-controlled user logs into the host, only a login by another access-controlled user changes the current user. 
    
 
     
     [bookmark: pgfId-2804055] 
     [bookmark: 50760]custom detection list 
    
 
     
     [bookmark: pgfId-2804111]A list of files as represented by their 
     SHA-256 hash values. When the system detects a file in the list, it does not perform a 
     malware cloud lookup, treating the file as malware, even if the 
     disposition for the file in the 
     Collective Security Intelligence Cloud is Clean. 
    
 
     
     [bookmark: pgfId-2598908]custom fingerprint 
    
 
     
     [bookmark: pgfId-2598912]See 
     fingerprint. 
    
 
     
     [bookmark: pgfId-2598913]custom table 
    
 
     
     [bookmark: pgfId-2598914]A table you can construct that combines fields from two or more of the predefined tables delivered with the FireSIGHT System. For example, you could combine the 
     host criticality information from the 
     host attributes table with information from the 
      connection data table to examine connection data in a new context. 
    
 
     
     [bookmark: pgfId-2598927]custom topology 
    
 
     
     [bookmark: pgfId-2598928]A feature that allows you to meaningfully organize and identify subnets in the 
     host, 
     mobile device, and 
     network device 
     network maps. 
    
 
     
     [bookmark: pgfId-2598929] 
     [bookmark: 34472]custom user role 
    
 
     
     [bookmark: pgfId-2598930]A 
     user role with specialized access privileges. Custom user roles may have any set of menu-based and system permissions, and may be completely original or based on a predefined user role. 
    
 
     
     [bookmark: pgfId-2598931] 
     [bookmark: 59693]custom workflow 
    
 
     
     [bookmark: pgfId-2598935]A 
     workflow that you create to meet the unique needs of your organization. 
    
 
     
     [bookmark: pgfId-2598936] 
     [bookmark: 30225]dashboard 
    
 
     
     [bookmark: pgfId-2630344]A display that provides at-a-glance views of current system status, including data about the 
     events collected and generated by the system. To augment the dashboards delivered with the system, you can create multiple custom dashboards, populated with the 
     dashboard widgets you choose. Compare with the 
     Context Explorer, which offers a broad, brief, and colorful picture of how your monitored network looks and acts. 
    
 
     
     [bookmark: pgfId-2598941] 
     [bookmark: 83039]dashboard widget 
    
 
     
     [bookmark: pgfId-2598942]A small, self-contained 
     dashboard component that provides insight into an aspect of the FireSIGHT System. 
    
 
     
     [bookmark: pgfId-2598946] 
     [bookmark: 30730]data correlator 
    
 
     
     [bookmark: pgfId-2598952]A program that generates 
     events and creates the 
     network map on the 
     Defense Center, using the data collected by the system. 
    
 
     
     [bookmark: pgfId-2598954]database access 
    
 
     
     [bookmark: pgfId-2598958]A feature that allows read-only access to the 
     Defense Center database by a third-party client. 
    
 
     
     [bookmark: pgfId-2598959] 
     [bookmark: 42890]decoder 
    
 
     
     [bookmark: pgfId-2598960]A component of 
     intrusion detection and prevention, configured in a 
     network analysis policy, that places sniffed packets into a format that can be understood by a 
     preprocessor. 
    
 
     
     [bookmark: pgfId-2598965] 
     [bookmark: 72456]default action 
    
 
     
     [bookmark: pgfId-2598966]As part of an 
     access control policy or 
     SSL policy, the 
     action that specifies how to handle, inspect, and log traffic that does not meet the conditions of any non- 
     Monitor rule in the policy. 
    
 
     
     [bookmark: pgfId-2852771] 
     [bookmark: 95575]Defense Center 
    
 
     
     [bookmark: pgfId-2852736]A central management point that allows you to manage 
     devices and automatically aggregate and correlate the 
     events they generate. 
    
 
     
     [bookmark: pgfId-2598976] 
     [bookmark: 36816]defragmentation policy 
    
 
     
     [bookmark: pgfId-2598980]A sub-policy that describes how the IP defragmentation 
     preprocessor (configured in a 
     network analysis policy) should reassemble fragmented IP packets, based on the target 
     host’s operating system. Note that 
     adaptive profiles use adaptive defragmentation policies. 
    
 
     
     [bookmark: pgfId-2598984]derived fingerprint 
    
 
     
     [bookmark: pgfId-2598988]An operating system 
     fingerprint created by the system from all passively collected fingerprints for a 
     host by applying a formula which calculates the most likely identity, using the confidence value of each collected fingerprint and the amount of corroborating fingerprint data between identities. 
    
 
     
     [bookmark: pgfId-2598990] 
     [bookmark: 48257]device 
    
 
     
     [bookmark: pgfId-2662160]A physical fault-tolerant, purpose-built 
     appliance (including 
     Cisco ASA with FirePOWER Services) available in a range of throughputs, or a software-based deployment with many of the same capabilities. Depending on the licensed capabilities you enable on your devices, you can use them to passively monitor traffic to build a comprehensive map of your network assets, 
     application traffic, and 
     user activity, as well as perform 
     access control. Many devices can also perform switching, routing (including DHCP relay and 
     NAT), and 
     VPN. You must manage devices with a 
     Defense Center. 
    
 
     
     [bookmark: pgfId-2598996] 
     [bookmark: 91531]device clustering 
    
 
     
     [bookmark: pgfId-2599000]See 
     clustering. 
    
 
     
     [bookmark: pgfId-2661809]device stacking 
    
 
     
     [bookmark: pgfId-2661833]See 
     stacking. 
    
 
     
     [bookmark: pgfId-2624577] 
     [bookmark: 23869]discovery 
    
 
     
     [bookmark: pgfId-2662712]A component of the FireSIGHT System that uses managed 
     devices to monitor your network and provide you with a complete, persistent view of your network. Network discovery determines the number and types of 
     hosts (including 
     network devices and 
     mobile devices) on your network, as well as information about the operating systems, active 
     applications, and open ports on those hosts. You can also configure managed devices to monitor 
     user activity on your network, which allows you to identify the source of policy breaches, attacks, or network vulnerabilities. 
    
 
     
     [bookmark: pgfId-2662444] 
     [bookmark: 52834]discovery data 
    
 
     
     [bookmark: pgfId-2662448]Host, user, and 
     application information that qualifies your network assets and traffic flow, as gathered by the 
     discovery feature. 
    
 
     
     [bookmark: pgfId-2606606] 
     [bookmark: 25007]discovery event 
    
 
     
     [bookmark: pgfId-2606612]An 
     event that details the 
     discovery of new assets or changes to existing assets. A 
     host input event is a special kind of discovery event. Sometimes, “discovery event” refers to any 
     discovery data or 
     vulnerability information. 
    
 
     
     [bookmark: pgfId-2599036] 
     [bookmark: 40571]discovery policy 
    
 
     
     [bookmark: pgfId-2599040]See 
     network discovery policy. 
    
 
     
     [bookmark: pgfId-2646707] 
     [bookmark: 81153]discovery rule 
    
 
     
     [bookmark: pgfId-2646708]Within a 
     network discovery policy, specifies the networks and 
     zones you want to monitor and the 
     devices (including 
     NetFlow-enabled devices) or you want to use to monitor them, as well as any ports you want to exclude from monitoring. Each rule also specifies whether you want to discover 
     hosts, 
     users, or 
     applications on the monitored networks. 
    
 
     
     [bookmark: pgfId-2696784] 
     [bookmark: 68007]disposition 
    
 
     
     [bookmark: pgfId-2696820]See 
     malware disposition. 
    
 
     
     [bookmark: pgfId-2864385] 
     [bookmark: 81515]distinguished name object 
    
 
     
     [bookmark: pgfId-2864417]A reusable 
     object that represents a public key certificate's subject or issuer distinguished name. 
    
 
     
     [bookmark: pgfId-2599041] 
     [bookmark: 31795]drill-down page 
    
 
     
     [bookmark: pgfId-2599045]An intermediate 
     workflow page used to constrain 
     event views. Generally, a drill-down page presents constraints that you can select to advance to a more narrowly constrained page or a 
     table view. 
    
 
     
     [bookmark: pgfId-2599049] 
     [bookmark: 65116]drop event 
    
 
     
     [bookmark: pgfId-2599056]An 
     intrusion event generated when a 
     drop rule triggers. In the 
     event viewer, drop events are marked with black down arrows. 
    
 
     
     [bookmark: pgfId-2599058] 
     [bookmark: 94023]drop rule 
    
 
     
     [bookmark: pgfId-2719746]An 
     intrusion rule whose 
     rule state is set to Drop and Generate Events. When a malicious packet triggers the rule in an 
     inline deployment, and the 
     intrusion policy you 
     apply is set to drop when inline, the system drops the packet and generates an 
     intrusion event (specifically, a 
     drop event). 
    
 
     
     [bookmark: pgfId-2805904] 
     [bookmark: 89407]dynamic analysis 
    
 
     
     [bookmark: pgfId-2805982]A method of submitting 
     captured files from a 
     device to the 
     Collective Security Intelligence Cloud for malware analysis. The cloud runs the file in a test environment and returns a 
     threat score and 
     dynamic analysis summary report to the 
     Defense Center. From the dynamic analysis summary report, you can also view the 
     VRT Analysis Report. 
    
 
     
     [bookmark: pgfId-2808151] 
     [bookmark: 46138]dynamic analysis summary report 
    
 
     
     [bookmark: pgfId-2808284]A summary of why the 
     Collective Security Intelligence Cloud assigned a 
     threat score to a file, including any threats discovered during 
     dynamic analysis, as well as additional processes detected when running the file in the test environment. From here, you can also view the 
     VRT Analysis Report. 
    
 
     
     [bookmark: pgfId-2720119]dynamic rule state 
    
 
     
     [bookmark: pgfId-2719318]A intrusion 
     rule state that is set for a specified period of time in response to a detected rate anomaly in traffic matching the rule. 
    
 
     
     [bookmark: pgfId-2857004] 
     [bookmark: 50295]elliptic curve (EC) cryptography 
    
 
     
     [bookmark: pgfId-2857028]A cryptographic method based on calculating points on a random elliptic curve over a finite field. Contrast with 
     RSA cryptography. 
    
 
     
     [bookmark: pgfId-2719319] 
     [bookmark: 51300]endpoint 
    
 
     
     [bookmark: pgfId-2720488]A computer or mobile device where your users install a 
     FireAMP Connector as part of your organization’s 
     advanced malware protection strategy. 
    
 
     
     [bookmark: pgfId-2719324] 
     [bookmark: 59041]eStreamer 
    
 
     
     [bookmark: pgfId-2599087]A component of the FireSIGHT System that allows you to stream 
     event data from a 
     Defense Center or managed 
     device to external 
     client applications. 
    
 
     
     [bookmark: pgfId-2599091] 
     [bookmark: 69546]event 
    
 
     
     [bookmark: pgfId-2737259]A collection of details about a specific occurrence that you can view in the 
     event viewer, using 
     workflows. Events may represent attacks on your network, changes in your detected network assets, violations of your organization’s security and network use policies, and so on. The system also generates events that contain information about the changing health status of 
     appliances, your use of the web interface, 
     rule updates, and launched 
     remediations. Finally, the system presents certain other information as events, even though these “events” do not represent particular occurrences. For example, you can use the event viewer to view detailed information about detected 
     hosts, 
     applications, and their vulnerabilities. 
    
 
     
     [bookmark: pgfId-2599093]Event Streamer 
    
 
     
     [bookmark: pgfId-2599097]See 
     eStreamer. 
    
 
     
     [bookmark: pgfId-2599098] 
     [bookmark: 75319]event suppression 
    
 
     
     [bookmark: pgfId-2599102]A feature that allows you to use suppress 
     intrusion events when a specific IP address or range of IP addresses triggers an 
     intrusion rule. Event suppression is useful for eliminating false positives. For example, if you have an email server that transmits packets that look like a specific exploit, you can suppress events for the rules that are triggered by that server, so you only see the events for legitimate attacks. 
    
 
     
     [bookmark: pgfId-2599103] 
     [bookmark: 35847]event thresholding 
    
 
     
     [bookmark: pgfId-2599104]A feature that allows you to limit the number of times the system logs and displays an 
     intrusion event, based on how many times the event is generated within a specified time period. Use event thresholding if you are overwhelmed with a large number of identical events. 
    
 
     
     [bookmark: pgfId-2855238]event traffic channel 
    
 
     
     [bookmark: pgfId-2855262]See 
     traffic channel. 
    
 
     
     [bookmark: pgfId-2599108] 
     [bookmark: 77409]event viewer 
    
 
     
     [bookmark: pgfId-2599109]A component of the system that allows you to view and manipulate 
     events. The event viewer uses 
     workflows to present a broad, then a more focused event view that contains only the events of interest to you. You can constrain the events in an event view by drilling down through the workflow, or by using a search. 
    
 
     
     [bookmark: pgfId-2599113] 
     [bookmark: 91524]export 
    
 
     
     [bookmark: pgfId-2599114]A method that you can use to transfer various configurations (such as policies) from 
     appliance to appliance. After you export a configuration from one appliance, you can 
     import it onto another appliance of the same type. 
    
 
     
     [bookmark: pgfId-2599118] 
     [bookmark: 75018]external authentication 
    
 
     
     [bookmark: pgfId-2599125]A method (such as 
     LDAP authentication or 
     RADIUS authentication) that uses externally stored user credentials to authenticate user names and passwords when users log into FireSIGHT System 
     appliances. Compare with 
     internal authentication. 
    
 
     
     [bookmark: pgfId-2641495]failsafe 
    
 
     
     [bookmark: pgfId-2599136]A characteristic of an 
     inline set that allows packets to bypass processing and continue through the 
     device if internal traffic buffers are full. 
    
 
     
     [bookmark: pgfId-2599137] 
     [bookmark: 45862]fast-path rule 
    
 
     
     [bookmark: pgfId-2599138]A 
     rule that you configure at a 
     device’s hardware level, using a limited set of criteria, to allow traffic that does not need to be analyzed to bypass processing. 
    
 
     
     [bookmark: pgfId-2660007]feed 
    
 
     
     [bookmark: pgfId-2660008]See 
     Security Intelligence feed. 
    
 
     
     [bookmark: pgfId-2599139] 
     [bookmark: 76259]fingerprint 
    
 
     
     [bookmark: pgfId-2805142]An established definition that the system compares against specific packet header values and other unique data from network traffic to identify a 
     host's operating system. If the system misidentifies or cannot identify a host's operating system, you can create a custom fingerprint that identifies the host. 
    
 
     
     [bookmark: pgfId-2806612]file capture 
    
 
     
     [bookmark: pgfId-2806640]See 
     captured file. 
    
 
     
     [bookmark: pgfId-2805147] 
     [bookmark: 35458]file category 
    
 
     
     [bookmark: pgfId-2694823]A general classification for 
     file types, such as graphics, executables, or archives. 
    
 
     
     [bookmark: pgfId-2691900] 
     [bookmark: 47024]file control 
    
 
     
     [bookmark: pgfId-2710210]A feature that, as part of 
     access control, allows you to specify and log the types of files that can traverse your network. 
    
 
     
     [bookmark: pgfId-2696825] 
     [bookmark: 81934]file disposition 
    
 
     
     [bookmark: pgfId-2696851]See 
     malware disposition. 
    
 
     
     [bookmark: pgfId-2691684] 
     [bookmark: 63219]file event 
    
 
     
     [bookmark: pgfId-2712460]An 
     event that represents a file detected in network traffic by a managed 
     device. 
    
 
     
     [bookmark: pgfId-2737117] 
     [bookmark: 38417]file list 
    
 
     
     [bookmark: pgfId-2737174]See 
     clean list and 
     custom detection list. 
    
 
     
     [bookmark: pgfId-2691776] 
     [bookmark: 32610]file policy 
    
 
     
     [bookmark: pgfId-2711317]A 
     policy that the system uses to perform 
     file control and network-based 
     advanced malware protection. Populated by 
     file rules, a file policy is invoked by an 
     access control rule within an 
     access control policy. 
    
 
     
     [bookmark: pgfId-2710757] 
     [bookmark: 13994]file rule 
    
 
     
     [bookmark: pgfId-2786324]A set of criteria within a 
     file policy that the FireSIGHT System uses to examine network traffic. If a transmitted file matches the rule criteria, the rule triggers and generates a 
     file event. The 
     file rule action determine whether you block the file (based on 
     file type or 
     malware disposition) or simply allow the file to pass and log the transmission. 
    
 
     
     [bookmark: pgfId-2693436] 
     [bookmark: 56417]file rule action 
    
 
     
     [bookmark: pgfId-2700738]A setting that determines how the system handles a file that meets the conditions of a 
     file rule. You can detect and alert on specific 
     file types, as well as block the transmission of those files. You can also perform 
     malware cloud lookups on a subset of those file types and block the transmission of those files based on 
     malware disposition. 
    
 
     
     [bookmark: pgfId-2807888] 
     [bookmark: 15944]file storage 
    
 
     
     [bookmark: pgfId-2807955]See 
     stored file. 
    
 
     
     [bookmark: pgfId-2734054] 
     [bookmark: 18093]file trajectory 
    
 
     
     [bookmark: pgfId-2734134]See 
     network file trajectory. 
    
 
     
     [bookmark: pgfId-2693320] 
     [bookmark: 88702]file type 
    
 
     
     [bookmark: pgfId-2693393]A specific type of file format, such as PDF, EXE, or MP3. 
    
 
     
     [bookmark: pgfId-2790127] 
     [bookmark: 78085]FireAMP 
    
 
     
     [bookmark: pgfId-2790134]Cisco’s enterprise-class, 
     endpoint-based, advanced malware analysis and protection solution that discovers, understands, and blocks malware outbreaks, persistent threats, and targeted attacks. If your organization has a 
     FireAMP subscription, individual users install lightweight 
     FireAMP Connectors on endpoints (computers, mobile devices), which then communicate with the 
     Collective Security Intelligence Cloud. This allows you to quickly identify and quarantine malware, as well as identify outbreaks when they occur, track their trajectory, understand their effects, and learn how to successfully recover. You can also use the 
     FireAMP portal to create custom protections, block execution of certain applications, and create custom whitelists. Compare with network-based 
     advanced malware protection. 
    
 
     
     [bookmark: pgfId-2790066] 
     [bookmark: 91633]FireAMP Connector 
    
 
     
     [bookmark: pgfId-2740867]A lightweight agent that users in a subscription-based 
     FireAMP deployment install on 
     endpoints, such as computers and mobile devices. Connectors communicate with the 
     Collective Security Intelligence Cloud, exchanging information that allow you to quickly identify and quarantine malware throughout your organization. They can also identify 
     indications of compromise (IOC) on endpoint hosts. 
    
 
     
     [bookmark: pgfId-2705122] 
     [bookmark: 39745]FireAMP portal 
    
 
     
     [bookmark: pgfId-2705213]The website, 
       http://amp.sourcefire.com/ , where you can configure your organization’s subscription-based 
     FireAMP deployment. 
    
 
     
     [bookmark: pgfId-2854222] 
     [bookmark: 11837]FireAMP Private Cloud 
    
 
     
     [bookmark: pgfId-2854229]A 
     FireAMP-provided virtual machine that acts as a secure mediator between your monitored network and the 
     Collective Security Intelligence Cloud for 
     FireAMP-based (file and malware) features. All connections to the cloud occur over the private cloud’s anonymized proxy connection, rather than from individual agents or 
     appliances on your network. 
    
 
     
     [bookmark: pgfId-2717189] 
     [bookmark: 37194]FireAMP subscription 
    
 
     
     [bookmark: pgfId-2717220]A separately purchased subscription that allows your organization to use 
     FireAMP as an 
     advanced malware protection (AMP) solution. Compare with a 
     Malware license, which you enable on managed 
     devices to perform network-based AMP. 
    
 
     
     [bookmark: pgfId-2678240] 
     [bookmark: 79271]FireSIGHT license 
    
 
     
     [bookmark: pgfId-2599148]The default license on the 
     Defense Center, which allows you to perform 
     host, 
     application, and user discovery. The FireSIGHT license also determines how many individual 
     hosts and users you can monitor with the 
     Defense Center and its managed 
     devices, as well as the number of 
     access-controlled users you can use in 
     access control rules to perform 
     user control. 
    
 
     
     [bookmark: pgfId-2599159] 
     [bookmark: 79756]FireSIGHT Recommendations layer 
    
 
     
     [bookmark: pgfId-2599166]A 
     built-in layer in an 
     intrusion policy that exists when you allow the system to modify 
     rule states to those recommended by the 
     FireSIGHT recommended rules feature. 
    
 
     
     [bookmark: pgfId-2599179] 
     [bookmark: 32979]FireSIGHT recommended rules 
    
 
     
     [bookmark: pgfId-2695420]A feature that recommends which rules should be enabled or disabled in your 
     intrusion policy, based on information from your 
     network map. You can choose to allow the system to modify 
     rule states based on recommendations, in which case the system adds a read-only 
     FireSIGHT Recommendations layer. 
    
 
     
     [bookmark: pgfId-2875336] 
     [bookmark: 53225]generator ID (GID) 
    
 
     
     [bookmark: pgfId-2875388]A number that indicates which component of the system generated an 
     intrusion event. GIDs help you analyze events more effectively by categorizing the type of event in the same way a rule’s 
     Signature ID (Sid) offers context for the packets that trigger rules. 
    
 
     
     [bookmark: pgfId-2745058]GeoDB 
    
 
     
     [bookmark: pgfId-2745059]See 
     geolocation database (GeoDB). 
    
 
     
     [bookmark: pgfId-2745060] 
     [bookmark: 61468]geolocation 
    
 
     
     [bookmark: pgfId-2745099]A feature that provides data on the geographical source of routable IP addresses detected in traffic on your monitored network, including connection type, Internet service provider, and so on. You can see geolocation information in events and 
     host profiles, and use it to filter traffic in an 
     access control policy or 
     SSL policy. 
    
 
     
     [bookmark: pgfId-2744748] 
     [bookmark: 40895]geolocation database (GeoDB) 
    
 
     
     [bookmark: pgfId-2744749]A regularly updated database of known 
     geolocation data associated with routable IP addresses. 
    
 
     
     [bookmark: pgfId-2648860] 
     [bookmark: 64102]GID 
    
 
     
     [bookmark: pgfId-2875355]See 
     generator ID (GID). 
    
 
     
     [bookmark: pgfId-2675430] 
     [bookmark: 81951]global blacklist 
    
 
     
     [bookmark: pgfId-2770524]A 
     Security Intelligence object included by default in every 
     access control policy’s 
     Security Intelligence blacklist. The global blacklist applies to all 
     security zones. You can add individual IP addresses to the global blacklist using the IP address 
     context menu in the 
     dashboard, 
     Context Explorer, and many 
     event viewer pages. 
    
 
     
     [bookmark: pgfId-2770541] 
     [bookmark: 74646] 
     [bookmark: 90183]global whitelist 
    
 
     
     [bookmark: pgfId-2770588]A 
     Security Intelligence object included by default in every 
     access control policy’s 
     Security Intelligence whitelist. The global whitelist applies to all 
     security zones. You can add individual IP addresses to the global whitelist using the IP address 
     context menu in the 
     dashboard, 
     Context Explorer, and many 
     event viewer pages. 
    
 
     
     [bookmark: pgfId-2770619] 
     [bookmark: 88982]HA link interface 
    
 
     
     [bookmark: pgfId-2599199]Also called the high availability link interface, a 
     physical interface that you configure on each member of a clustered pair of 
     devices to act as a redundant communications channel for sharing health information between the devices. 
    
 
     
     [bookmark: pgfId-2599200] 
     [bookmark: 96689]health event 
    
 
     
     [bookmark: pgfId-2599204]An 
     event generated when one of the 
     appliances in your deployment meets (or fails to meet) performance criteria specified in a 
     health module. Health events can also generate 
     alerts. 
    
 
     
     [bookmark: pgfId-2599208] 
     [bookmark: 35955]health module 
    
 
     
     [bookmark: pgfId-2599209]A test of a particular performance aspect, such as CPU usage or available disk space, of the 
     appliances in your deployment. Health modules, which you enable in a 
     health policy, generate 
     health events when the performance aspects they monitor reach a certain level. 
    
 
     
     [bookmark: pgfId-2599213] 
     [bookmark: 61707]health monitor 
    
 
     
     [bookmark: pgfId-2599214]A feature that continuously monitors the performance of the 
     appliances in your deployment. The health monitor uses 
     health modules within an applied 
     health policy to test the appliances. 
    
 
     
     [bookmark: pgfId-2599218] 
     [bookmark: 27337]health monitor blacklist 
    
 
     
     [bookmark: pgfId-2631220]A configuration that temporarily disables aspects of health monitoring to prevent the generation of unnecessary 
     health events. You can disable monitoring for a group of 
     appliances, a single appliance, or a specific 
     health module. 
    
 
     
     [bookmark: pgfId-2599220] 
     [bookmark: 10635]health policy 
    
 
     
     [bookmark: pgfId-2599221]The criteria used when checking the health of an 
     appliance in your deployment. Health policies use 
     health modules to indicate whether system hardware and software are working correctly. You can use the default health policy or create your own. 
    
 
     
     [bookmark: pgfId-2599229] 
     [bookmark: 25115]high availability 
    
 
     
     [bookmark: pgfId-2599233]A feature that allows you to configure redundant physical 
     Defense Centers to manage groups of 
     devices. Event data streams from managed devices to both Defense Centers and most configuration elements are maintained on both Defense Centers. If your primary Defense Center fails, you can monitor your network without interruption using the secondary Defense Center. Compare with 
     clustering, which allows you to designate redundant devices. 
    
 
     
     [bookmark: pgfId-2599249] 
     [bookmark: 91051]host 
    
 
     
     [bookmark: pgfId-2599250]A device that is connected to a network and has a unique IP address. To the FireSIGHT System, a host is any identified host that is not categorized as a 
     mobile device, bridge, 
     router, 
     NAT device, or 
     load balancer. 
    
 
     
     [bookmark: pgfId-2599266] 
     [bookmark: 50417]host attribute 
    
 
     
     [bookmark: pgfId-2599267]A tool you can use to provide information about 
     hosts detected by the system, classifying them in ways that are important to your network environment. The system has two predefined host attributes, 
     host criticality and notes, as well as host attributes that indicate the compliance of each host with each active 
     compliance white list. You can also create your own host attributes. 
    
 
     
     [bookmark: pgfId-2599271] 
     [bookmark: 51296]host criticality 
    
 
     
     [bookmark: pgfId-2599275]A 
     host attribute that indicates the business criticality (importance) of any given 
     host detected by the system. 
    
 
     
     [bookmark: pgfId-2599276] 
     [bookmark: 16775]host history 
    
 
     
     [bookmark: pgfId-2599277]A graphical representation of the last 24 hours of a user’s activity. The host history, which you can view in a user’s 
     user details, displays the IP addresses of the 
     hosts that the user logged into, with approximate login and logout times represented by bar graphs. 
    
 
     
     [bookmark: pgfId-2860609] 
     [bookmark: 63675]host input 
    
 
     
     [bookmark: pgfId-2860613]A feature that allows you to import data from third-party sources using scripts or command-line files to augment the information in the 
     network map. The web interface also provides some host input functionality; you can modify operating system or 
     application protocol identities, validate or invalidate vulnerabilities, and delete various items from the network map, including 
     clients and 
     server ports. 
    
 
     
     [bookmark: pgfId-2599288] 
     [bookmark: 64836]host input event 
    
 
     
     [bookmark: pgfId-2599295]A kind of 
     discovery event that is generated when you use the 
     host input feature. In general, the system treats host input and passive discovery events identically, though they are distinguished when building 
     correlation rules. 
    
 
     
     [bookmark: pgfId-2599299] 
     [bookmark: 84593]host profile 
    
 
     
     [bookmark: pgfId-2599300]Collected information about a specific detected 
     host. This includes general 
     host information, such as its name and operating system, as well as the protocols and 
     applications running on the host. The host profile may also include 
     user history, 
     host attributes, 
     Virtual local area network (VLAN) information, applicable 
     white list violations, detected vulnerabilities, 
     indications of compromise (IOC), and scan results for that host. 
    
 
     
     [bookmark: pgfId-2599307] 
     [bookmark: 21267]host profile qualification 
    
 
     
     [bookmark: pgfId-2599314]A constraint placed on a 
     traffic profile or 
     correlation rule. A host profile qualification within a correlation rule specifies that the 
     Defense Center should generate a 
     correlation event only if the 
     host involved meets certain criteria. A host profile qualification within a traffic profile limits the hosts that are profiled. 
    
 
     
     [bookmark: pgfId-2599321] 
     [bookmark: 10502]host view 
    
 
     
     [bookmark: pgfId-2599325]The final page in 
     workflows that display 
     discovery events or network assets. The host view displays the 
     host profiles of the 
     hosts involved in the events or assets you are viewing. 
    
 
     
     [bookmark: pgfId-2657762] 
     [bookmark: 10322]HTTP response page 
    
 
     
     [bookmark: pgfId-2657817]A web page you can configure the system to display when a user’s HTTP request is blocked by 
     access control. You can display a generic Cisco-provided response page, or you can provide custom HTML. If the request was blocked by an 
     Interactive Block rule, you can allow users to click a button on the response page to continue to the originally requested site. 
    
 
     
     [bookmark: pgfId-2599329]hybrid interface 
    
 
     
     [bookmark: pgfId-2599330]A 
     logical interface on a managed 
     device that allows the system to bridge traffic between a 
     virtual router and a 
     virtual switch. 
    
 
     
     [bookmark: pgfId-2599331] 
     [bookmark: 42510]identity conflict 
    
 
     
     [bookmark: pgfId-2599332]The conflict that occurs when the system reports a new passive operating system or 
     server identity that conflicts with the current active identity and previously reported passive identities. 
    
 
     
     [bookmark: pgfId-2599333] 
     [bookmark: 27761]impact 
    
 
     
     [bookmark: pgfId-2656727]For 
     intrusion events, a numbered indicator of the correlation between 
     intrusion data, 
     discovery data, and 
     vulnerability information. Impact level 1 (red impact icon) means that the targeted 
     host is 
      vulnerable to the attack represented by the intrusion event, impact level 2 (orange impact icon) means it is 
      potentially vulnerable , and so on. Attacks directed at hosts on networks not monitored by the 
     network discovery policy are impact level 0 (gray impact icon), which indicates that the 
     Defense Center cannot determine the events’ impact. 
    
 
     
     [bookmark: pgfId-2599345] 
     [bookmark: 71512]import 
    
 
     
     [bookmark: pgfId-2599346]A method that you can use to transfer various configurations from 
     appliance to appliance. You can import configurations that you previously 
     exported from another appliance of the same type. 
    
 
     
     [bookmark: pgfId-2599347] 
     [bookmark: 92673]inactive period 
    
 
     
     [bookmark: pgfId-2599351]An interval during which a 
     correlation rule does not trigger. You can configure the time, frequency, and duration of inactive periods. See also 
     snooze period. 
    
 
     
     [bookmark: pgfId-2599355] 
     [bookmark: 32238]incident 
    
 
     
     [bookmark: pgfId-2599359]One or more 
     intrusion events that you suspect are involved in a possible violation of your 
     security policy. The system provides incident-handling features that you can use to collect and process information that is relevant to your investigation of the incident. 
    
 
     
     [bookmark: pgfId-2800878] 
     [bookmark: 50398]indications of compromise (IOC) 
    
 
     
     [bookmark: pgfId-2800962]Configured in the 
     network discovery policy, a feature where the system correlates 
     FireAMP endpoint data with hosts on your monitored network. Potentially compromised hosts are marked with tags to indicate their status, visible in the 
     host profile and in relevant event views. 
    
 
     
     [bookmark: pgfId-2599363] 
     [bookmark: 20960]inline deployment 
    
 
     
     [bookmark: pgfId-2599367]A deployment of the FireSIGHT System where your managed 
     devices are placed inline on a network. In this configuration, devices can affect network traffic flow. Contrast with passive detection, where you can analyze and respond to, but not affect, the flow of traffic. 
    
 
     
     [bookmark: pgfId-2599371] 
     [bookmark: 12235]inline interface 
    
 
     
     [bookmark: pgfId-2599372]A 
     sensing interface configured to handle traffic in an 
     inline deployment. You must add inline interfaces to 
     inline sets in pairs. 
    
 
     
     [bookmark: pgfId-2599374] 
     [bookmark: 93551]inline set 
    
 
     
     [bookmark: pgfId-2599375]One or more pairs of 
     inline interfaces. 
    
 
     
     [bookmark: pgfId-2872121] 
     [bookmark: 44321]Intelligence Feed 
    
 
     
     [bookmark: pgfId-2872125]A collection of regularly updated lists of IP addresses determined by the 
     Cisco VRT to have a poor reputation. Each list in the Intelligence Feed represents a specific category: open relays, known attackers, bogus IP addresses (bogon), and so on. In an 
     access control policy, you can 
     blacklist any or all of the categories using 
     Security Intelligence. Because the Intelligence Feed is regularly updated, using it ensures that the system uses up-to-date information to filter your network traffic. 
    
 
     
     [bookmark: pgfId-2660391] 
     [bookmark: 27928]Interactive Block 
    
 
     
     [bookmark: pgfId-2681761]An 
     access control rule action that allows your users to click a button on an 
     HTTP response page to continue to an initially blocked web site. 
    
 
     
     [bookmark: pgfId-2599376] 
     [bookmark: 54769]internal authentication 
    
 
     
     [bookmark: pgfId-2599377]An authentication method that stores user credentials in a local database on the 
     appliance. When a user logs into the appliance, the user name and password are checked against the information in the database. Compare with 
     external authentication. 
    
 
     
     [bookmark: pgfId-2599381] 
     [bookmark: 10962]intrusion 
    
 
     
     [bookmark: pgfId-2599382]A security breach, attack, or exploit that occurs on your network. 
    
 
     
     [bookmark: pgfId-2599398] 
     [bookmark: 27785]intrusion detection and prevention 
    
 
     
     [bookmark: pgfId-2599399]The monitoring of your network traffic for 
     security policy violations, and, in 
     inline deployments, the ability to block or alter malicious traffic. In the FireSIGHT System, you perform intrusion detection and prevention when you preprocess traffic with a 
     network analysis policy, then associate an 
     intrusion policy with an 
     access control rule or 
     default action. 
    
 
     
     [bookmark: pgfId-2599403] 
     [bookmark: 61605]intrusion event 
    
 
     
     [bookmark: pgfId-2599407]An 
     event that records an 
     intrusion policy violation. Intrusion event data includes the date, time, and the type of exploit, as well as other contextual information about the attack and its target. 
    
 
     
     [bookmark: pgfId-2599408] 
     [bookmark: 64461]intrusion policy 
    
 
     
     [bookmark: pgfId-2861234]A variety of components that you can configure to inspect your network traffic for 
     intrusions and 
     security policy violations. When your network traffic meets the conditions in an 
     access control rule, you can inspect that traffic with an intrusion policy; you can also associate an intrusion policy with the 
     access control policy’s 
     default action. The main components of an intrusion policy are 
     intrusion rules, which inspect traffic, and 
     preprocessor rules, which generate events for associated preprocessor options in the 
     network analysis policy. You can also add an optional 
     FireSIGHT Recommendations layer, as well as configure advanced settings to inspect sensitive data or perform special 
     intrusion event handling. Intrusion policies are always paired with 
     variable sets. 
    
 
     
     [bookmark: pgfId-2599428] 
     [bookmark: 40930]intrusion rule 
    
 
     
     [bookmark: pgfId-2635623]A set of keywords and arguments that, when applied to monitored network traffic, identify potential 
     intrusions, 
     security policy violations, and security breaches. The system compares packets against rule conditions. If the packet data matches the conditions, the rule triggers and generates an 
     intrusion event. Intrusion rules include 
     drop rules and 
     pass rules. 
    
 
     
     [bookmark: pgfId-2635633] 
     [bookmark: 39051]layer 
    
 
     
     [bookmark: pgfId-2599449]A complete set of configurations within an 
     intrusion policy or 
     network analysis policy. You can add custom 
     user layers to the 
     built-in layer in your policy. A setting in a higher layer overrides a setting in a lower layer. 
    
 
     
     [bookmark: pgfId-2599459] 
     [bookmark: 27198]LDAP authentication 
    
 
     
     [bookmark: pgfId-2599463]A form of 
     external authentication that verifies user credentials by comparing them to a Lightweight Directory Access Protocol (LDAP) directory stored on an LDAP directory server. 
    
 
     
     [bookmark: pgfId-2599464]Lights-Out Management (LOM) 
    
 
     
     [bookmark: pgfId-2599465]A 
     Series 3 feature that allows you to use an out-of-band Serial over LAN (SOL) management connection to remotely monitor or manage certain 
     appliances without logging into the web interface of the appliance. You can perform limited tasks, such as viewing the chassis serial number or monitoring such conditions as fan speed and temperature. 
    
 
     
     [bookmark: pgfId-2857563]Link Aggregation Control Protocol (LACP) 
    
 
     
     [bookmark: pgfId-2857702]A component of the IEEE 802.3ad specification that provides a method of exchanging system and port information to control the bundling of several physical ports together to form a single logical data channel called a link aggregation group (LAG). When you enable LACP, each device on either end of the channel uses LACP to determine which links will be actively used in the aggregation. 
    
 
     
     [bookmark: pgfId-2857696]link aggregation group (LAG) 
    
 
     
     [bookmark: pgfId-2857545]A 
     Series 3 feature that allows you to group multiple physical Ethernet interfaces into a single logical link on 
     managed devices configured in either a Layer 2 deployment that provides packet switching between networks, or a Layer 3 deployment that routes traffic between interfaces. This single aggregate logical link provides higher bandwidth, redundancy, and load-balancing between two endpoints. 
    
 
     
     [bookmark: pgfId-2599469]link state propagation 
    
 
     
     [bookmark: pgfId-2599476]An option for 
     inline sets in bypass mode that automatically brings down the second interface in a pair when one of the interfaces in an inline set goes down. When the downed interface comes back up, the second interface automatically comes back up also. In other words, if the link state of a paired interface changes, the link state of the other interface changes automatically to match it. 
    
 
     
     [bookmark: pgfId-2659856]list 
    
 
     
     [bookmark: pgfId-2659963]See 
     Security Intelligence list. 
    
 
     
     [bookmark: pgfId-2599478] 
     [bookmark: 36442]load balancer 
    
 
     
     [bookmark: pgfId-2599482]A 
     network device that distributes traffic to optimize performance and resource use. Using 
     discovery, the system can identify 
     load balancers. 
    
 
     
     [bookmark: pgfId-2599483] 
     [bookmark: 48806]logical interface 
    
 
     
     [bookmark: pgfId-2702397]A virtual subinterface that you define to handle traffic with specific 
     Virtual local area network (VLAN) tags as the tagged traffic passes through a 
     physical interface. 
    
 
     
     [bookmark: pgfId-2736348] 
     [bookmark: 73886]malware blocking 
    
 
     
     [bookmark: pgfId-2736407]A component of Cisco’s network-based 
     advanced malware protection (AMP) solution. In an inline deployment, if 
     malware detection yields a malware 
     disposition for a detected file or the detected file is on the 
     custom detection list, you can either block the file or allow its upload or download. Compare this functionality with 
     FireAMP, Cisco’s endpoint-based AMP tool that requires a 
     FireAMP subscription. 
    
 
     
     [bookmark: pgfId-2702402] 
     [bookmark: 82240]malware cloud lookup 
    
 
     
     [bookmark: pgfId-2702541]A process by which the 
     Defense Center communicates with the 
     Collective Security Intelligence Cloud to determine the 
     malware disposition of a file detected in network traffic, based on the file’s 
     SHA-256 hash value. 
    
 
     
     [bookmark: pgfId-2696414] 
     [bookmark: 72284]malware detection 
    
 
     
     [bookmark: pgfId-2696415]A component of Cisco’s network-based 
     advanced malware protection (AMP) solution. File policies applied to managed 
     devices as part of your overall 
     access control configuration inspect network traffic. The 
     Defense Center then performs 
     malware cloud lookups for specific detected 
     file types, and generates events that alert you to the files’ 
     malware dispositions. AMP 
     malware blocking follows and either blocks the file or allows its upload or download. Compare this functionality with 
     FireAMP, Cisco’s endpoint-based AMP tool that requires a 
     FireAMP subscription. 
    
 
     
     [bookmark: pgfId-2696864] 
     [bookmark: 49769]malware disposition 
    
 
     
     [bookmark: pgfId-2742808]A determination by the 
     Collective Security Intelligence Cloud as to whether a file contains malware, based on the file’s 
     SHA-256 hash value, 
     threat score, and whether the file is on the 
     clean list or 
     custom detection list. 
    
 
     
     [bookmark: pgfId-2777486]malware disposition cache 
    
 
     
     [bookmark: pgfId-2777487]A cache on the 
     Defense Center that stores 
     malware dispositions and 
     threat scores for files. To improve performance, if the system already knows the disposition or threat score for a file based on its 
     SHA-256 hash value, the Defense Center uses the cached information rather than performing a 
     malware cloud lookup. Information in the cache times out after a certain period of time so that cache data does not become stale. 
    
 
     
     [bookmark: pgfId-2777489] 
     [bookmark: 88775]malware event 
    
 
     
     [bookmark: pgfId-2717151]An 
     event generated by one of Cisco’s 
     advanced malware protection solutions. Network-based malware events are generated when the 
     Collective Security Intelligence Cloud returns a 
     malware disposition for a file detected in network traffic; 
     retrospective malware events are generated when that disposition changes. Compare with 
     endpoint-based malware events, which are generated when a deployed 
     FireAMP Connector detects a threat, blocks malware execution, or quarantines or fails to quarantine malware. 
    
 
     
     [bookmark: pgfId-2692537] 
     [bookmark: 43900]Malware license 
    
 
     
     [bookmark: pgfId-2702945]A license that allows you to perform 
     advanced malware protection (AMP) in network traffic. Using a 
     file policy, you can configure the system to perform 
     malware cloud lookups on specific 
     file types detected by managed 
     devices. Compare with 
     FireAMP subscription. 
    
 
     
     [bookmark: pgfId-2736692]malware protection 
    
 
     
     [bookmark: pgfId-2736753]See 
     advanced malware protection. 
    
 
     
     [bookmark: pgfId-2806654] 
     [bookmark: 97896]malware storage pack 
    
 
     
     [bookmark: pgfId-2806741]A secondary solid-state drive supplied by Cisco that you can install in certain 
     devices to store 
     captured files, freeing space on the device’s primary hard drive for 
     event and configuration storage. 
    
 
     
     [bookmark: pgfId-2599485] 
     [bookmark: 19532]managed device 
    
 
     
     [bookmark: pgfId-2599489]See 
     device. 
    
 
     
     [bookmark: pgfId-2599490] 
     [bookmark: 58379]management interface 
    
 
     
     [bookmark: pgfId-2861686]The network interface that you use to administer a FireSIGHT System 
     appliance. In most deployments, the management interface is connected to an internal 
     protected network. Compare with 
     sensing interface. On 
     virtual Defense Centers and all 
     Series 3 appliances, you can configure multiple management interfaces to either separate traffic into channels to improve performance, or to create a route to an additional network to allow a Defense Center to isolate traffic on different networks. You can also route 
     traffic channels to separate networks to increase throughput capacity. 
    
 
     
     [bookmark: pgfId-2855281]management traffic channel 
    
 
     
     [bookmark: pgfId-2855285]See 
     traffic channel. 
    
 
     
     [bookmark: pgfId-2660456] 
     [bookmark: 28979]mobile device 
    
 
     
     [bookmark: pgfId-2672453]In the FireSIGHT System, a 
     host identified by the 
     discovery feature as a mobile, handheld device (such as a mobile phone or tablet). The system can often detect whether a mobile device is jailbroken. 
    
 
     
     [bookmark: pgfId-2663533] 
     [bookmark: 60142]Monitor 
    
 
     
     [bookmark: pgfId-2663534]A way to log matching traffic, but also to allow the system to continue evaluating the connection rather than immediately allowing or blocking it. You can monitor traffic that violates a 
     Security Intelligence blacklist, or that matches any combination of criteria in an 
     access control rule or 
     SSL rule. 
    
 
     
     [bookmark: pgfId-2771504] 
     [bookmark: 79719]NAT 
    
 
     
     [bookmark: pgfId-2771505]Network address translation, a feature most commonly used to share a single Internet connection among multiple 
     hosts on a private network. Using 
     discovery, the system can identify 
     network devices as 
     load balancers. In addition, in a Layer 3 deployment of the FireSIGHT System, you can configure routing with NAT using a 
     NAT policy. 
    
 
     
     [bookmark: pgfId-2791850] 
     [bookmark: 53825]NAT policy 
    
 
     
     [bookmark: pgfId-2791854]A policy that uses 
     NAT rules to perform routing with 
     NAT. 
    
 
     
     [bookmark: pgfId-2792080] 
     [bookmark: 69430]NAT rule 
    
 
     
     [bookmark: pgfId-2793653]A set of configurations and conditions that evaluate network traffic and specify how traffic matching those qualifications is translated. NAT rules are added to an existing 
     NAT policy to perform routing using 
     NAT. 
    
 
     
     [bookmark: pgfId-2599521] 
     [bookmark: 18417]NetFlow 
    
 
     
     [bookmark: pgfId-2599522]An open but proprietary network protocol for collecting IP traffic information, developed by Cisco to run on Cisco IOS-enabled equipment. You can use the information collected by NetFlow-enabled devices to supplement the discovery and 
     connection data collected by the FireSIGHT System and to monitor networks not covered by managed 
     devices. 
    
 
     
     [bookmark: pgfId-2660488] 
     [bookmark: 71385]NetMod 
    
 
     
     [bookmark: pgfId-2762953]A module that you install in the chassis of a managed 
     device that contains the 
     sensing interfaces for that device. 
    
 
     
     [bookmark: pgfId-2857947] 
     [bookmark: 17812]network analysis policy 
    
 
     
     [bookmark: pgfId-2864016]A variety of 
     preprocessors that you can configure to decode, normalize, and preprocess network traffic in preparation for later analysis by an 
     intrusion policy. By default, a single system-provided network analysis policy preprocesses all traffic handled by an 
     access control policy. However, you can choose a custom network analysis policy to perform this preprocessing. Advanced users can use 
     network analysis rules to allow multiple custom network analysis policies to preprocess traffic based on security zone, network, or VLAN tag. 
    
 
     
     [bookmark: pgfId-2857977] 
     [bookmark: 39154]network analysis rule 
    
 
     
     [bookmark: pgfId-2863579]A set of conditions that advanced FireSIGHT System users can use to perform targeted preprocessing using multiple custom network analysis policies. You configure network analysis rules as an advanced option in an 
     access control policy. 
    
 
     
     [bookmark: pgfId-2737096] 
     [bookmark: 73081]network device 
    
 
     
     [bookmark: pgfId-2662072]In the FireSIGHT System, a 
     host identified as a bridge, 
     router, 
     NAT device, or 
     load balancer. 
    
 
     
     [bookmark: pgfId-2662077] 
     [bookmark: 31653]network discovery 
    
 
     
     [bookmark: pgfId-2662303]See 
     discovery. 
    
 
     
     [bookmark: pgfId-2662101] 
     [bookmark: 11659]network discovery policy 
    
 
     
     [bookmark: pgfId-2599554]A 
     policy that specifies the kinds of 
     discovery data (including 
     host, user, and 
     application data) the system collects for specific network segments, including networks monitored by 
     NetFlow-enabled devices. The network discovery policy also manages 
     identity conflict resolution preferences, 
     active detection source priorities, and 
     indications of compromise (IOC). 
    
 
     
     [bookmark: pgfId-2759755] 
     [bookmark: 97395]network file trajectory 
    
 
     
     [bookmark: pgfId-2759796]A visual representation of a file’s path as 
     hosts transfer it across your network. For any file with an associated 
     SHA-256 hash value, the trajectory map displays the IP addresses of all hosts that have transferred the file, the time the file was detected, the file’s 
     malware disposition, associated 
     file events and 
     malware events, and so on. 
    
 
     
     [bookmark: pgfId-2599556] 
     [bookmark: 16992]network map 
    
 
     
     [bookmark: pgfId-2599557]A detailed representation of your network. The network map allows you to view your network topology in terms of the 
     hosts, 
     mobile devices, and 
     network devices running on your network, as well as their associated 
     host attributes, 
     application protocols, and vulnerabilities. 
    
 
     
     [bookmark: pgfId-2599570] 
     [bookmark: 47451]network object 
    
 
     
     [bookmark: pgfId-2599571]A reusable 
     object that represents one or more IP addresses, CIDR blocks, or prefix lengths. 
    
 
     
     [bookmark: pgfId-2599573] 
     [bookmark: 20539]Nmap 
    
 
     
     [bookmark: pgfId-2599574]Network Mapper, an open source active scanner that you can use to detect operating systems and 
     application protocols running on a host. Running an 
     Nmap scan adds the information detected to your 
     network map. 
    
 
     
     [bookmark: pgfId-2599581] 
     [bookmark: 98078]non-access-controlled user 
    
 
     
     [bookmark: pgfId-2626287]Any user, whether detected by the 
     User Agent or a managed 
     device, that is not used for 
     access control. A non-access-controlled user can only be the 
     current user for a 
     host if no 
     access-controlled user has ever logged into the host. 
    
 
     
     [bookmark: pgfId-2753883]non-bypass mode 
    
 
     
     [bookmark: pgfId-2753917]A characteristic of an 
     inline set that blocks traffic if the 
     sensing interfaces in the set fail for any reason. 
    
 
     
     [bookmark: pgfId-2626292] 
     [bookmark: 83718]object 
    
 
     
     [bookmark: pgfId-2636324]A reusable configuration that associates a name with a value (for example, an IP address or URL) so that when you want to use that value in the web interface, you can use the named object instead. You create objects using the 
     object manager. See also: 
     network object, 
     Security Intelligence object, 
     port object, 
     VLAN tag object, 
     URL object, 
     application filter, 
     variable set, 
     file list, 
     HA link interface, 
     security zone, 
     cipher suite list, 
     distinguished name object, and 
     PKI object. 
    
 
     
     [bookmark: pgfId-2772183] 
     [bookmark: 52518]object manager 
    
 
     
     [bookmark: pgfId-2772187]The page on the web interface where you manage 
     objects and object groups. 
    
 
     
     [bookmark: pgfId-2599600]operating system identity 
    
 
     
     [bookmark: pgfId-2599601]The operating system vendor and version details for an operating system on a 
     host. 
    
 
     
     [bookmark: pgfId-2599605] 
     [bookmark: 11922]packet view 
    
 
     
     [bookmark: pgfId-2599609]A type of 
     workflow page that provides detailed information about the packet that triggered an 
     intrusion rule or the 
     preprocessor that generated an 
     intrusion event. The packet view is the final page in 
     workflows based on intrusion events. 
    
 
     
     [bookmark: pgfId-2599623] 
     [bookmark: 61839]pass rule 
    
 
     
     [bookmark: pgfId-2599630]An 
     intrusion rule that, when triggered, does not generate an 
     intrusion event and does not log the details of the packet that triggered the rule. Pass rules allow you to prevent packets that meet specific criteria from generating an event in specific situations, as an alternative to disabling the intrusion rule. Compare with 
     drop rule. 
    
 
     
     [bookmark: pgfId-2599650] 
     [bookmark: 32992]passive detection 
    
 
     
     [bookmark: pgfId-2599654]The collection of 
     discovery data through analysis of traffic passively collected by managed 
     devices. Compare with 
     active detection. 
    
 
     
     [bookmark: pgfId-2599655]passive interface 
    
 
     
     [bookmark: pgfId-2599656]A 
     sensing interface configured to analyze traffic in a passive deployment. 
    
 
     
     [bookmark: pgfId-2599657]pending (application protocol) 
    
 
     
     [bookmark: pgfId-2602693]A designation given to an 
     application protocol identity when the system can neither positively nor negatively identify the application protocol. Most often, the system needs to collect and analyze more data before it can identify a pending application protocol. 
    
 
     
     [bookmark: pgfId-2599659] 
     [bookmark: 99739]physical interface 
    
 
     
     [bookmark: pgfId-2599660]An interface that represents a physical port on a 
     NetMod. 
    
 
     
     [bookmark: pgfId-2853825]PKI 
    
 
     
     [bookmark: pgfId-2853829]See 
     public key infrastructure (PKI). 
    
 
     
     [bookmark: pgfId-2864612] 
     [bookmark: 38992]PKI object 
    
 
     
     [bookmark: pgfId-2864624]Reusable 
     objects that represent 
     public key certificates and paired 
     private keys. 
    
 
     
     [bookmark: pgfId-2599662] 
     [bookmark: 74049]policy 
    
 
     
     [bookmark: pgfId-2599666]A mechanism for applying settings, most often to an 
     appliance. See 
     access control policy, 
     correlation policy, 
     file policy, 
     health policy, 
     intrusion policy, 
     network analysis policy, 
     network discovery policy, 
     SSL policy, and 
     system policy. 
    
 
     
     [bookmark: pgfId-2599688] 
     [bookmark: 96093]policy target 
    
 
     
     [bookmark: pgfId-2599689]An 
     appliance or 
     zone where you 
     apply a 
     policy. A policy may have multiple targets. 
    
 
     
     [bookmark: pgfId-2599695] 
     [bookmark: 87245]port object 
    
 
     
     [bookmark: pgfId-2768859]A reusable 
     object that represents an open port that uses transport layer protocols (for example, TCP, UDP, or ICMP). 
    
 
     
     [bookmark: pgfId-2768861] 
     [bookmark: 49490]preprocessor 
    
 
     
     [bookmark: pgfId-2856357]A component of the system that prepares traffic to be further inspected for intrusions and exploits. Preprocessors normalize traffic and help identify network layer and transport layer protocol anomalies by identifying inappropriate header options, defragmenting IP datagrams, providing TCP stateful inspection and stream reassembly, and validating checksums. Preprocessors can also render specific types of packet data in a format that the system can analyze; these preprocessors are called data normalization preprocessors, or application layer protocol preprocessors. Normalizing application layer protocol encoding allows the system to effectively apply the same content-related intrusion rules to packets whose data is represented differently and obtain meaningful results. Preprocessors generate 
     preprocessor events whenever packets trigger preprocessor options that you configure. Preprocessors require specific expertise to configure, typically require little or no modification, and are not common to every deployment. 
    
 
     
     [bookmark: pgfId-2856362] 
     [bookmark: 56397]preprocessor event 
    
 
     
     [bookmark: pgfId-2856369]A type of 
     intrusion event that is generated when a packet triggers specified 
     preprocessor options. Preprocessor events can help you detect anomalous protocol exploits. 
    
 
     
     [bookmark: pgfId-2599735] 
     [bookmark: 99982]preprocessor rule 
    
 
     
     [bookmark: pgfId-2599742]An 
     intrusion rule associated with a 
     preprocessor or with the portscan flow detector. You must enable preprocessor rules if you want them to generate 
     events. Preprocessor rules have a preprocessor-specific 
     generator ID (GID). 
    
 
     
     [bookmark: pgfId-2853835] 
     [bookmark: 96770]private key 
    
 
     
     [bookmark: pgfId-2853842]A cryptographic key known only to the owner of the paired 
     public key certificate. The 
     public key and private key are used for 
     Secure Sockets Layer (SSL) and 
     Transport Layer Security encryption and decryption. 
    
 
     
     [bookmark: pgfId-2599758]private search 
    
 
     
     [bookmark: pgfId-2599759]A named set of search criteria for a specific table, tied to your user account. Only you and users with Administrator access can use your private searches. 
    
 
     
     [bookmark: pgfId-2599760] 
     [bookmark: 60071]protected network 
    
 
     
     [bookmark: pgfId-2599761]Your organization’s internal network that is protected from users of other networks by a device such as a firewall. Many of the 
     intrusion rules delivered with the system use 
     variables to define the protected network and the unprotected (or outside) network. 
    
 
     
     [bookmark: pgfId-2737763] 
     [bookmark: 22591]Protection license 
    
 
     
     [bookmark: pgfId-2739563]A license that allows you to perform 
     intrusion detection and prevention, 
     file control, and 
     Security Intelligence filtering. Without a license, 
     Series 2 devices automatically have Protection capabilities, with the exception of Security Intelligence. 
    
 
     
     [bookmark: pgfId-2853853] 
     [bookmark: 31913]public key 
    
 
     
     [bookmark: pgfId-2853857]A cryptographic key associated with a 
     public key certificate that is available to everyone. The public key and paired 
     private key are used for 
     Secure Sockets Layer (SSL) and 
     Transport Layer Security encryption and decryption. 
    
 
     
     [bookmark: pgfId-2853868] 
     [bookmark: 77261]public key certificate 
    
 
     
     [bookmark: pgfId-2853875]A digital document issued by a 
     certificate authority to an individual that confirms the 
     public key stored in the certificate belongs to the individual. 
    
 
     
     [bookmark: pgfId-2853877] 
     [bookmark: 51454]public key infrastructure (PKI) 
    
 
     
     [bookmark: pgfId-2853887]A system to manage how a 
     certificate authority issues 
     public key certificates and paired 
     private keys to individuals. 
    
 
     
     [bookmark: pgfId-2603775] 
     [bookmark: 25212]RADIUS authentication 
    
 
     
     [bookmark: pgfId-2648957]Remote Authentication Dial In User Service, a service used to authenticate, authorize, and account for user access to network resources. You can create an external 
     authentication object to allow FireSIGHT System users to authenticate through a RADIUS server. 
    
 
     
     [bookmark: pgfId-2599784]rate filtering 
    
 
     
     [bookmark: pgfId-2599788]A form of anomaly detection that sets a new 
     intrusion rule state for a rule based on the rate of matching traffic. 
    
 
     
     [bookmark: pgfId-2599789] 
     [bookmark: 27510]remediation 
    
 
     
     [bookmark: pgfId-2637970]An action that mitigates potential attacks on your system. You can configure remediations and, within a 
     correlation policy, associate them with 
     correlation rules and 
     compliance white lists so that when they trigger, the 
     Defense Center launches the remediation. This can not only automatically mitigate attacks when you are not immediately available to address them, but can also ensure that your system remains compliant with your organization’s 
     security policy. The Defense Center ships with predefined 
     remediation modules, and you can also use a flexible API to create custom remediations. 
    
 
     
     [bookmark: pgfId-2599809] 
     [bookmark: 40818]remediation instance 
    
 
     
     [bookmark: pgfId-2599810]A set of configurations for a 
     remediation module. You can configure multiple instances per module, for example, you could respond to different correlation policy violations using the same module, but different instances that have different settings. When a remediation instance triggers, the resulting action is called a 
     remediation. 
    
 
     
     [bookmark: pgfId-2599811] 
     [bookmark: 24834]remediation module 
    
 
     
     [bookmark: pgfId-2599812]A program that launches a 
     remediation, using sets of configurations called 
     remediation instances. The FireSIGHT System ships with several remediation modules that perform various actions; you can also use a flexible API to create your own modules. 
    
 
     
     [bookmark: pgfId-2599813]remediation status event 
    
 
     
     [bookmark: pgfId-2599817]An 
     event generated when a 
     remediation is launched. 
    
 
     
     [bookmark: pgfId-2603807]report template 
    
 
     
     [bookmark: pgfId-2603808]A template that specifies the data constraints and formats for a report and its sections. 
    
 
     
     [bookmark: pgfId-2759941]reputation (IP address) 
    
 
     
     [bookmark: pgfId-2760013]See 
     Security Intelligence. 
    
 
     
     [bookmark: pgfId-2599823]reputation (URL) 
    
 
     
     [bookmark: pgfId-2599824]See 
     URL reputation. 
    
 
     
     [bookmark: pgfId-2599825] 
     [bookmark: 73890]response 
    
 
     
     [bookmark: pgfId-2700377]A reaction to a 
     correlation policy violation — either an 
     alert or a 
     remediation. 
    
 
     
     [bookmark: pgfId-2700378] 
     [bookmark: 10195]retrospective malware event 
    
 
     
     [bookmark: pgfId-2698658]A network-based 
     malware event generated when the 
     malware disposition for a previously detected file changes. When this occurs, the system also updates the dispositions for files and malware that share the retrospective event’s 
     SHA-256 hash value. 
    
 
     
     [bookmark: pgfId-2599836] 
     [bookmark: 93520]risk 
    
 
     
     [bookmark: pgfId-2599837]See 
     application risk. 
    
 
     
     [bookmark: pgfId-2599838] 
     [bookmark: 30892]routed interface 
    
 
     
     [bookmark: pgfId-2599839]An interface that routes traffic in a Layer 3 deployment. You can set up physical routed interfaces for handling untagged 
     Virtual local area network (VLAN) traffic, and logical routed interfaces for handling traffic with designated VLAN tags. You can also add static Address Resolution Protocol (ARP) entries to routed interfaces. 
    
 
     
     [bookmark: pgfId-2599840] 
     [bookmark: 25903]router 
    
 
     
     [bookmark: pgfId-2857338]A 
     network device, located at a gateway, that forwards packets between networks. Using 
     network discovery, the system can identify routers. In addition, you can configure managed 
     devices as 
     virtual routers that route traffic between two or more interfaces. 
    
 
     
     [bookmark: pgfId-2857354] 
     [bookmark: 48624]RSA cryptography 
    
 
     
     [bookmark: pgfId-2857355]A cryptographic method based on factoring a large number into two prime numbers. Contrast with 
     elliptic curve (EC) cryptography. 
    
 
     
     [bookmark: pgfId-2857348] 
     [bookmark: 45132]rule 
    
 
     
     [bookmark: pgfId-2599848]A construct, often within a 
     policy, that provides criteria against which network traffic is examined. See also: 
     access control rule, 
     correlation rule, 
     discovery rule, 
     fast-path rule, 
     file rule, 
     intrusion rule, 
     network analysis rule, 
     preprocessor rule, and 
     SSL rule. 
    
 
     
     [bookmark: pgfId-2693398]rule action 
    
 
     
     [bookmark: pgfId-2693423]A setting that determines how the system handles network traffic that meets the conditions of a 
     rule. See also: 
     access control rule action, 
     file rule action, and 
     SSL rule action. 
    
 
     
     [bookmark: pgfId-2599867] 
     [bookmark: 10988]rule state 
    
 
     
     [bookmark: pgfId-2599871]Whether an 
     intrusion rule is enabled (set to Generate Events or Drop and Generate Events), or disabled (set to Disable) within an 
     intrusion policy. If you enable a rule, it is used to evaluate your network traffic; if you disable a rule, it is not used. 
    
 
     
     [bookmark: pgfId-2599881] 
     [bookmark: 63414]rule update 
    
 
     
     [bookmark: pgfId-2599887]An as-needed 
     intrusion rule update that contains new and updated 
     standard text rules, 
     shared object rules, and 
     preprocessor rules. A rule update may also delete rules; modify default 
     intrusion policy, 
     network analysis policy, and advanced 
     access control policy settings; and add or delete default variables and rule categories. 
    
 
     
     [bookmark: pgfId-2669236]scheduled task 
    
 
     
     [bookmark: pgfId-2669237]An administrative task that you can schedule to run once or at recurring intervals. 
    
 
     
     [bookmark: pgfId-2853893] 
     [bookmark: 51344]Secure Sockets Layer (SSL) 
    
 
     
     [bookmark: pgfId-2853899]A cryptographic application layer protocol that preceded the 
     Transport Layer Security protocol. The 
     SSL inspection feature allows you to decrypt traffic encrypted with the SSL protocol. 
    
 
     
     [bookmark: pgfId-2669239] 
     [bookmark: 42234]Security Intelligence 
    
 
     
     [bookmark: pgfId-2670498]A feature that allows you to specify the traffic that can traverse your network, per 
     access control policy, based on the source or destination IP address. This is especially useful if you want to blacklist—deny traffic to and from—specific IP addresses, before the traffic is subjected to analysis by 
     access control rules. Optionally, you can use a 
     Monitor setting for Security Intelligence filtering, which allows the system to analyze connections that would have been blacklisted, but also logs the match to the blacklist. 
    
 
     
     [bookmark: pgfId-2669149] 
     [bookmark: 77810]Security Intelligence blacklist 
    
 
     
     [bookmark: pgfId-2669738]In an 
     access control policy, a list of IP addresses that allows you to deny traffic to and from those hosts, before the traffic is subjected to analysis by 
     access control rules. A blacklist is comprised of 
     Security Intelligence objects, including the 
     global blacklist. An access control policy’s 
     Security Intelligence whitelist overrides its blacklist. 
    
 
     
     [bookmark: pgfId-2860008] 
     [bookmark: 94135]Security Intelligence event 
    
 
     
     [bookmark: pgfId-2875138]A 
     connection event generated by traffic that is blocked or monitored by the 
     Security Intelligence blacklist. You can view and interact with Security Intelligence events independently from ordinary connection events. 
    
 
     
     [bookmark: pgfId-2659573] 
     [bookmark: 80902]Security Intelligence feed 
    
 
     
     [bookmark: pgfId-2659630]One of the types of 
     Security Intelligence objects, a dynamic collection of IP addresses that the system downloads on a regular basis, at an interval you configure. Because feeds are regularly updated, using them ensures that the system uses up-to-date information to filter your network traffic using the 
     Security Intelligence feature. See also the 
     Intelligence Feed. 
    
 
     
     [bookmark: pgfId-2659642] 
     [bookmark: 67941]Security Intelligence list 
    
 
     
     [bookmark: pgfId-2671184]A simple static collection of IP addresses that you manually upload to the 
     Defense Center as a 
     Security Intelligence object. Use lists to augment and fine-tune 
     Security Intelligence feeds as well as the 
     global blacklist and 
     global whitelist. 
    
 
     
     [bookmark: pgfId-2663883] 
     [bookmark: 32813]Security Intelligence object 
    
 
     
     [bookmark: pgfId-2669942]A single configuration that represents one or more IP addresses, and that you add to an 
     access control policy’s 
     Security Intelligence blacklist and 
     Security Intelligence whitelist. Security Intelligence objects include 
     Security Intelligence lists, 
     Security Intelligence feeds, and 
     network objects and groups. The 
     global blacklist, 
     global whitelist, and the categories in the 
     Intelligence Feed are also considered Security Intelligence objects. 
    
 
     
     [bookmark: pgfId-2669065] 
     [bookmark: 57187]Security Intelligence whitelist 
    
 
     
     [bookmark: pgfId-2671509]In an 
     access control policy, a list of IP addresses that forces the policy to examine traffic to and from those hosts using 
     access control rules, that is, to not deny the traffic using 
     Security Intelligence. Because a policy’s whitelist overrides its 
     Security Intelligence blacklist, you can use it to fine-tune the blacklist. A whitelist is comprised of 
     Security Intelligence objects, including the 
     global whitelist. 
    
 
     
     [bookmark: pgfId-2599920] 
     [bookmark: 38271]security policy 
    
 
     
     [bookmark: pgfId-2599921]An organization's guidelines for protecting its network. For example, your 
     security policy might forbid the use of wireless access points. A security policy may also include an acceptable use policy (AUP), which provides employees with guidelines of how they may use their organization’s systems. 
    
 
     
     [bookmark: pgfId-2603159]security policy violation 
    
 
     
     [bookmark: pgfId-2603160]A security breach, attack, exploit, or other misuse of your network. 
    
 
     
     [bookmark: pgfId-2599925] 
     [bookmark: 42530]security zone 
    
 
     
     [bookmark: pgfId-2599926]A grouping of one or more inline, passive, switched, or 
     routed interfaces that you can use to manage and classify traffic flow in various policies and configurations. The interfaces in a single zone may span multiple 
     devices; you can also configure multiple security zones on a single device. You must assign at least one interface to a security zone to match traffic against that security zone, and each interface can belong to only one zone. 
    
 
     
     [bookmark: pgfId-2599928] 
     [bookmark: 46840]sensing interface 
    
 
     
     [bookmark: pgfId-2599929]A network interface on a 
     device that you use to monitor a network segment. Compare with 
     management interface. 
    
 
     
     [bookmark: pgfId-2732580] 
     [bookmark: 63853]Series 2 
    
 
     
     [bookmark: pgfId-2740305]The second series of FireSIGHT System 
     appliance models. Because of resource, architecture, and licensing limitations, Series 2 appliances support a restricted set of features. Series 2 devices include the 3D500, 3D1000, 3D2000, 3D2100, 3D2500, 3D3500, 3D4500, 3D6500, and 3D9900. Series 2 
     Defense Centers include the DC500, DC1000, and DC3000. 
    
 
     
     [bookmark: pgfId-2740334] 
     [bookmark: 43800]Series 3 
    
 
     
     [bookmark: pgfId-2870575]The third series of FireSIGHT System 
     appliance models. Series 3 appliances include 
     7000 Series and 
     8000 Series 
     devices, as well as the DC750, DC1500, DC2000, DC3500, and DC4000 
     Defense Centers. 
    
 
     
     [bookmark: pgfId-2870586] 
     [bookmark: 92249]server 
    
 
     
     [bookmark: pgfId-2599953]The server 
     application (compare with 
     client application) installed on a 
     host, identified by 
     application protocol traffic. 
    
 
     
     [bookmark: pgfId-2599955] 
     [bookmark: 14788]server banner 
    
 
     
     [bookmark: pgfId-2599956]The first 256 bytes of the first packet detected for a 
     server, which can provide additional information that may help you identify the server. The system collects a server banner only once, the first time the server is detected. 
    
 
     
     [bookmark: pgfId-2645109] 
     [bookmark: 27907]server certificate 
    
 
     
     [bookmark: pgfId-2645130]An encrypted certificate issued by a 
     certificate authority that provides unalterable confirmation of the server identity. You can request a certificate from any certificate authority and upload that custom certificate to your 
     appliance. 
    
 
     
     [bookmark: pgfId-2599959]server identity 
    
 
     
     [bookmark: pgfId-2700696]The 
     application protocol type, vendor, and version details for a 
     server on a 
     host. 
    
 
     
     [bookmark: pgfId-2754107]SFP module 
    
 
     
     [bookmark: pgfId-2754198]A small form-factor pluggable transceiver that is inserted into a network module on a 71xx Family device. Sensing interfaces on SFP modules do not allow 
     configurable bypass. 
    
 
     
     [bookmark: pgfId-2754200] 
     [bookmark: 23636]SHA-256 hash value 
    
 
     
     [bookmark: pgfId-2700699]Sometimes abbreviated as SHA256, a 32-bit string that represents a file for which you are performing a 
     malware cloud lookup. The hash value is calculated using a cryptographic hash function so that files with identical SHA-256 values are very likely to have identical contents. 
    
 
     
     [bookmark: pgfId-2599975]shared layer 
    
 
     
     [bookmark: pgfId-2599982]An 
     intrusion policy or 
     network analysis policy 
     layer that you allow to be used by other policies. Policies using a shared layer are updated with changes in the shared layer when you commit those changes. A shared layer can be modified only in the policy that allows it to be shared; it is read-only in policies using it. 
    
 
     
     [bookmark: pgfId-2599992] 
     [bookmark: 96016]shared object rule 
    
 
     
     [bookmark: pgfId-2599996]An 
     intrusion rule delivered as a binary module compiled from C source code. You can use shared object rules to detect attacks in ways that 
     standard text rules cannot. You cannot modify the rule keywords and arguments in a shared object rule; you are limited to either modifying 
     variables used in the rule, or modifying aspects, such as the source and destination ports and IP addresses, and saving a new instance of the rule as a custom shared object rule. Shared object rules have a 
     generator ID (GID) of 3. 
    
 
     
     [bookmark: pgfId-2875676]SID 
    
 
     
     [bookmark: pgfId-2875680]See 
     Signature ID (Sid). 
    
 
     
     [bookmark: pgfId-2600012] 
     [bookmark: 11596]Signature ID (Sid) 
    
 
     
     [bookmark: pgfId-2600016]A unique identifying number assigned to each 
     intrusion rule (also known as a 
     Snort ID). When you create a new rule or modify an existing 
     standard text rule, it is given an SID of 1,000,000 or greater. The SIDs for 
     shared object rules and standard text rules delivered with the FireSIGHT System are lower than 1,000,000. Also, 
     preprocessors and 
     decoders use SIDs to identify the different types of packets they detect. 
    
 
     
     [bookmark: pgfId-2875648] 
     [bookmark: 15877]snooze period 
    
 
     
     [bookmark: pgfId-2875652]An interval specified in seconds, minutes, or hours after a 
     correlation rule triggers during which the system stops firing that rule, even if the rule is violated again during the interval. When the snooze period has ended, the rule can trigger again (and start a new snooze period). See also 
     inactive period. 
    
 
     
     [bookmark: pgfId-2772652] 
     [bookmark: 57838]Snort 
    
 
     
     [bookmark: pgfId-2862567]An open source intrusion detection system that performs real-time traffic analysis and packet logging on IP networks. Snort can perform protocol analysis, content searching and matching, and can detect a variety of attacks and probes. Snort uses a flexible rules language to describe network traffic that it should collect or pass. The FireSIGHT System uses Snort to test packets against 
     decoders, 
     preprocessors, and 
     intrusion rules. 
    
 
     
     [bookmark: pgfId-2862581] 
     [bookmark: 15751]Spero analysis 
    
 
     
     [bookmark: pgfId-2805752]A method of submitting file structural characteristics to the 
     Collective Security Intelligence Cloud for malware analysis. The results supplement 
     dynamic analysis. 
    
 
     
     [bookmark: pgfId-2853905]SSL 
    
 
     
     [bookmark: pgfId-2853909]See 
     Secure Sockets Layer (SSL). 
    
 
     
     [bookmark: pgfId-2853911] 
     [bookmark: 58676]SSL inspection 
    
 
     
     [bookmark: pgfId-2853912]A feature that allows you to inspect, decrypt, and log the encrypted traffic that traverses your network. Both traffic you choose not to decrypt and decrypted traffic can be further inspected with 
     access control. 
    
 
     
     [bookmark: pgfId-2853917] 
     [bookmark: 18395]SSL policy 
    
 
     
     [bookmark: pgfId-2853924]A policy that you apply as part of a parent 
     access control policy, and that performs 
     SSL inspection on the encrypted traffic monitored by 
     policy target devices. An SSL policy may include multiple 
     SSL rules; it also specifies a 
     default action, which determines the handling and logging of traffic that does not meet the criteria of any of those rules. An SSL policy can also specify how to handle undecryptable traffic, and what encrypted traffic it trusts, based on CA 
     public key certificates. 
    
 
     
     [bookmark: pgfId-2862701] 
     [bookmark: 97307]SSL rule 
    
 
     
     [bookmark: pgfId-2862704]A set of conditions the system uses to examine encrypted traffic and which allows 
     SSL inspection. 
     SSL rules, which populate an 
     SSL policy, may perform simple IP address matching, or may characterize complex connections involving different users, applications, ports, URLs, and encrypted session characteristics. The 
     SSL rule action determines how the system handles traffic that meets the rule’s conditions. Other rule settings determine how (and whether) the connection is logged. 
    
 
     
     [bookmark: pgfId-2853959] 
     [bookmark: 64002]SSL rule action 
    
 
     
     [bookmark: pgfId-2853960]A setting that determines how the system handles encrypted network traffic that meets the conditions of an 
     SSL rule. You can block matching traffic (with or without resetting the connection). You can also not decrypt encrypted traffic, decrypt incoming traffic with an uploaded 
     private key, decrypt outgoing traffic with a re-signed 
     public key certificate, or continue to monitor traffic with additional SSL rules. 
    
 
     
     [bookmark: pgfId-2788652] 
     [bookmark: 13895]stack 
    
 
     
     [bookmark: pgfId-2788676]Two to four connected 
     devices that share detection resources. 
    
 
     
     [bookmark: pgfId-2655950] 
     [bookmark: 97148]stacking 
    
 
     
     [bookmark: pgfId-2655951]A feature that allows you to increase the amount of traffic inspected on a network segment by connecting two to four physical 
     devices in a stacked configuration. When you establish a stacked configuration, you combine the resources of each stacked device into a single, shared configuration. 
    
 
     
     [bookmark: pgfId-2600071] 
     [bookmark: 56998]standard text rule 
    
 
     
     [bookmark: pgfId-2600075]An 
     intrusion rule created based on the identifiers, keywords, and arguments available in the rule editor. You can create your own custom standard text rules and modify Cisco-provided standard text rules. A standard text rule has a 
     generator ID (GID) of 1. 
    
 
     
     [bookmark: pgfId-2761882]state sharing 
    
 
     
     [bookmark: pgfId-2768838]A feature that allows clustered 
     devices or 
     stacks to synchronize so that if either device or stack fails, the peer can take over with no interruption to traffic flow. State sharing ensures that strict TCP enforcement, unidirectional 
     access control rules, blocking persistence, and dynamic 
     NAT fail over properly. 
    
 
     
     [bookmark: pgfId-2807619] 
     [bookmark: 64925]stored file 
    
 
     
     [bookmark: pgfId-2807648]A 
     captured file that is saved to a 
     device’s hard drive or 
     malware storage pack, if installed. Stored files can be downloaded and analyzed at a later time. 
    
 
     
     [bookmark: pgfId-2645336]sub-server 
    
 
     
     [bookmark: pgfId-2645358]A 
     server called by another server on the same host. 
    
 
     
     [bookmark: pgfId-2600093]suppression 
    
 
     
     [bookmark: pgfId-2600097]See 
     event suppression. 
    
 
     
     [bookmark: pgfId-2600098]SVID 
    
 
     
     [bookmark: pgfId-2600099]See 
     vulnerability ID. 
    
 
     
     [bookmark: pgfId-2600100] 
     [bookmark: 31855]switch 
    
 
     
     [bookmark: pgfId-2600104]A 
     network device that acts as a multiport bridge. Using 
     network discovery, the system identifies switches as bridges. In addition, you can configure managed 
     devices as 
     virtual switches, performing packet switching between two or more networks. 
    
 
     
     [bookmark: pgfId-2600105] 
     [bookmark: 50545]switched interface 
    
 
     
     [bookmark: pgfId-2600106]An interface that you want to use to switch traffic in a Layer 2 deployment. You can set up physical switched interfaces for handling untagged 
     Virtual local area network (VLAN) traffic, and logical switched interfaces for handling traffic with designated VLAN tags. 
    
 
     
     [bookmark: pgfId-2600108] 
     [bookmark: 29612]system policy 
    
 
     
     [bookmark: pgfId-2600109]Settings that are likely to be similar for multiple 
     appliances in a deployment, such as mail relay host preferences and time synchronization settings. Use the 
     Defense Center to 
     apply a system policy to itself and its managed 
     devices. 
    
 
     
     [bookmark: pgfId-2600116] 
     [bookmark: 55131]table view 
    
 
     
     [bookmark: pgfId-2630742]A type of 
     workflow page that displays 
     event information, with one column for each of the fields in the database table. When performing event analysis, you can use 
     drill-down pages to constrain the events you want to investigate before moving to the table view that shows you the details about the events you are interested in. The table view is often the next-to-last page in workflows delivered with the system. 
    
 
     
     [bookmark: pgfId-2600151]tag (application) 
    
 
     
     [bookmark: pgfId-2600152]See 
     application tag. 
    
 
     
     [bookmark: pgfId-2607186]tap mode 
    
 
     
     [bookmark: pgfId-2607190]An advanced 
     inline set option available on 3D9900 and 
     Series 3 devices where a copy of each packet is analyzed and the network traffic flow is undisturbed instead of passing through the 
     device. Because you are working with copies of packets rather than the packets themselves, the device cannot affect the packet stream even if you configure access control and intrusion policies to drop, modify, or block traffic. 
    
 
     
     [bookmark: pgfId-2600167]target device 
    
 
     
     [bookmark: pgfId-2600168]See 
     policy target. 
    
 
     
     [bookmark: pgfId-2625384]task queue 
    
 
     
     [bookmark: pgfId-2807114]A queue of jobs that the 
     appliance needs to perform. When you 
     apply a 
     policy, install software updates, and perform other long-running jobs, the jobs are queued and their status reported on the Task Status page. The Task Status page provides a detailed list of jobs and refreshes every ten seconds to update their status. 
    
 
     
     [bookmark: pgfId-2807116] 
     [bookmark: 45759]third-party vulnerability 
    
 
     
     [bookmark: pgfId-2600181]Vulnerability data obtained from a third party. If your organization can write scripts or create command line import files to 
     import 
     network map data from third-party 
     applications, you can use the 
     host input feature to import third-party 
     vulnerability data to augment the system’s vulnerability data. 
    
 
     
     [bookmark: pgfId-2807161] 
     [bookmark: 74760]threat score 
    
 
     
     [bookmark: pgfId-2807189]A rating of 1-100 assigned to a file as a result of submission to the 
     Collective Security Intelligence Cloud for 
     dynamic analysis that measures the likelihood the file contains malware. 
    
 
     
     [bookmark: pgfId-2600182]thresholding 
    
 
     
     [bookmark: pgfId-2600186]See 
     event thresholding. 
    
 
     
     [bookmark: pgfId-2600188] 
     [bookmark: 50071]time window 
    
 
     
     [bookmark: pgfId-2600189]A time constraint on the 
     events in any event view. Different event views may have different default time windows, depending on your user preferences. Note that not all event views can be constrained by time. 
    
 
     
     [bookmark: pgfId-2853974]TLS 
    
 
     
     [bookmark: pgfId-2854946]See 
     Transport Layer Security. 
    
 
     
     [bookmark: pgfId-2854960] 
     [bookmark: 60712]traffic channel 
    
 
     
     [bookmark: pgfId-2870642]A connection you can configure on the management interface of a 
     Series 3 
     appliance or 
     virtual Defense Center to carry either management or event traffic. The event traffic channel carries only event data generated on the managed device’s network segment and the management traffic channel carries only internally generated traffic (that is, management traffic between the Defense Center and the device). See 
     management interface. 
    
 
     
     [bookmark: pgfId-2854948] 
     [bookmark: 95398]traffic profile 
    
 
     
     [bookmark: pgfId-2854952]A profile of the traffic on your network, based on 
      connection events logged over a time span that you specify. You can create profiles using all the traffic on a monitored network segment, or you can create more targeted profiles. Then, you can use the 
     correlation feature to detect abnormal network traffic by evaluating new traffic against an existing profile. 
    
 
     
     [bookmark: pgfId-2600201]transparent inline mode 
    
 
     
     [bookmark: pgfId-2600208]An advanced 
     inline set option that allows a 
     device to act as a “bump in the wire” and to forward all the network traffic it sees, regardless of its source and destination. 
    
 
     
     [bookmark: pgfId-2853984] 
     [bookmark: 60528]Transport Layer Security 
    
 
     
     [bookmark: pgfId-2853990]A cryptographic application layer protocol that succeeded the 
     Secure Sockets Layer (SSL) protocol. The 
     SSL inspection feature allows you to decrypt traffic encrypted with the TLS protocol. 
    
 
     
     [bookmark: pgfId-2600212] 
     [bookmark: 49732]unidentified host 
    
 
     
     [bookmark: pgfId-2600213]A 
     host whose operating system cannot be identified because the system has not yet gathered enough information about the host. Compare with 
     unknown host. 
    
 
     
     [bookmark: pgfId-2600217]Unified file 
    
 
     
     [bookmark: pgfId-2600221]A binary file format that the FireSIGHT System uses to log 
     event data. 
    
 
     
     [bookmark: pgfId-2600222] 
     [bookmark: 24201]unknown host 
    
 
     
     [bookmark: pgfId-2600223]A 
     host whose traffic has been analyzed by the system, but whose operating system does not match any known 
     fingerprints. Compare with 
     unidentified host. 
    
 
     
     [bookmark: pgfId-2600231] 
     [bookmark: 55717]URL category 
    
 
     
     [bookmark: pgfId-2600232]A general classification for a URL, such as malware or social networking. 
    
 
     
     [bookmark: pgfId-2600233] 
     [bookmark: 72444]URL filtering 
    
 
     
     [bookmark: pgfId-2600234]A feature that allows you to write 
     access control rules that determine the traffic that can traverse your network based on URLs requested by monitored hosts, correlated with 
     URL category and 
     URL reputation information about those URLs, which is obtained from the 
     Collective Security Intelligence Cloud by the 
     Defense Center. You can also achieve more granular, custom control over web traffic by specifying individual URLs or groups of URLs to allow or block. 
    
 
     
     [bookmark: pgfId-2600235]URL Filtering license 
    
 
     
     [bookmark: pgfId-2600236]A license that allows you to perform 
     URL filtering based on 
     URL category and 
     URL reputation information. URL Filtering licenses may expire. 
    
 
     
     [bookmark: pgfId-2600237] 
     [bookmark: 72209]URL object 
    
 
     
     [bookmark: pgfId-2607566]A reusable 
     object that represents an individual URL. 
    
 
     
     [bookmark: pgfId-2600239] 
     [bookmark: 33561]URL reputation 
    
 
     
     [bookmark: pgfId-2718002]A representation of how likely a website is to be used for purposes that might be against your organization’s 
     security policy, as determined by the 
     Collective Security Intelligence Cloud. 
    
 
     
     [bookmark: pgfId-2718010] 
     [bookmark: 52189]user 
    
 
     
     [bookmark: pgfId-2718016]A user whose network activity has been detected by a managed 
     device or 
     User Agent. 
    
 
     
     [bookmark: pgfId-2607747] 
     [bookmark: 64660]user activity 
    
 
     
     [bookmark: pgfId-2628408]An 
     event generated when the system detects a user login or logoff (optionally, including some failed login attempts) or the addition or deletion of a user record from the 
     Defense Center database. 
    
 
     
     [bookmark: pgfId-2628413] 
     [bookmark: 70986]User Agent 
    
 
     
     [bookmark: pgfId-2604787]An agent you install on a 
     server to monitor users as they log into the network or when they authenticate against Active Directory credentials for any other reason. Activity by 
     access-controlled users is used for 
     access control only when a User Agent reports it. 
    
 
     
     [bookmark: pgfId-2604791] 
     [bookmark: 30429]user awareness 
    
 
     
     [bookmark: pgfId-2772780]A feature that allows your organization to correlate threat, endpoint, and network intelligence with 
     user identity information, and that allows you to perform 
     user control. 
    
 
     
     [bookmark: pgfId-2871805]user awareness object 
    
 
     
     [bookmark: pgfId-2871806]A collection of settings that allows you to connect to an LDAP server to retrieve metadata for users whose activity was detected in network traffic or by a 
     User Agent. If your organization uses Microsoft Active Directory, user awareness objects can also specify your 
     access-controlled users. 
    
 
     
     [bookmark: pgfId-2772787]user certificate 
    
 
     
     [bookmark: pgfId-2772790]An encrypted certificate that identifies a user's browser to the FireSIGHT System web server, allowing the server to do a secondary verification of user identity. The certificate must be issued by the same 
     certificate authority that issued the 
     server certificate for your 
     appliance. 
    
 
     
     [bookmark: pgfId-2772799] 
     [bookmark: 29422]user control 
    
 
     
     [bookmark: pgfId-2604851]A feature that, as part of 
     access control, allows you to specify and log the user-associated traffic that can traverse your network. 
    
 
     
     [bookmark: pgfId-2600257] 
     [bookmark: 92862]user details 
    
 
     
     [bookmark: pgfId-2605019]The final page in 
     user identity and 
     user activity 
     workflows. Along with general information about the user, the user details also display a 
     host history, which is a graphical representation of the last twenty-four hours of the user’s activity. 
    
 
     
     [bookmark: pgfId-2604672] 
     [bookmark: 10670]user history 
    
 
     
     [bookmark: pgfId-2621771]A graphical representation of the last twenty-four hours of 
     user activity for a 
     host. The user history, which you can view in a host’s 
     host profile, displays the user names of the users detected logging into the host, with approximate login and logout times represented by bar graphs. 
    
 
     
     [bookmark: pgfId-2858524] 
     [bookmark: 47545]user identity 
    
 
     
     [bookmark: pgfId-2858528]See 
     user. 
    
 
     
     [bookmark: pgfId-2858530] 
     [bookmark: 33808]user layer 
    
 
     
     [bookmark: pgfId-2600276]A 
     layer in an 
     intrusion policy where you can modify settings in the policy. 
    
 
     
     [bookmark: pgfId-2600277] 
     [bookmark: 60298]user role 
    
 
     
     [bookmark: pgfId-2600281]The level of access granted to a user of the FireSIGHT System. For example, you can grant different access privileges to the web interface for 
     event analysts, the administrator managing the FireSIGHT System, users accessing the 
     Defense Center database using third-party tools, and so on. You can also create custom roles with specialized access privileges. 
    
 
     
     [bookmark: pgfId-2600288]user role escalation 
    
 
     
     [bookmark: pgfId-2640343]A privilege you can give to 
     custom user roles that allows users to enter a password to gain the permissions of another 
     user role for the duration of a login session. 
    
 
     
     [bookmark: pgfId-2600290]UTC time 
    
 
     
     [bookmark: pgfId-2600291]Coordinated Universal Time. Also known as Greenwich Mean Time (GMT), UTC is the standard time common to every place in the world. The FireSIGHT System uses UTC, although you can set the local time using the Time Zone feature. 
    
 
     
     [bookmark: pgfId-2600295] 
     [bookmark: 48199]variable 
    
 
     
     [bookmark: pgfId-2600299]A representation of a value that is commonly used in 
     intrusion rules. The FireSIGHT System uses preconfigured variables, organized in 
     variable sets, to define networks and port numbers. Rather than hard-coding these values in multiple rules, to tailor a rule to accurately reflect your network environment, you can change the variable value. 
    
 
     
     [bookmark: pgfId-2798336] 
     [bookmark: 16036]variable set 
    
 
     
     [bookmark: pgfId-2798369]A collection of 
     variable configurations that you link to an 
     intrusion policy so you can tailor 
     intrusion rules enabled in each intrusion policy to closely match your network traffic. 
    
 
     
     [bookmark: pgfId-2608911]VDB 
    
 
     
     [bookmark: pgfId-2608926]See 
     vulnerability database. 
    
 
     
     [bookmark: pgfId-2664350] 
     [bookmark: 91095]virtual Defense Center 
    
 
     
     [bookmark: pgfId-2664371]A 
     Defense Center that you can deploy on your own equipment in a virtual hosting environment. 
    
 
     
     [bookmark: pgfId-2660206] 
     [bookmark: 98693]virtual device 
    
 
     
     [bookmark: pgfId-2674527]A managed 
     device that you can deploy on your own equipment in a virtual hosting environment. Virtual devices do not support hardware-based features, such as 
     high availability, 
     clustering, 
     stacking, 
     NAT, 
     VPN, and 
     fast-path rules, and you cannot configure a virtual device as a 
     virtual switch or 
     virtual router. 
    
 
     
     [bookmark: pgfId-2875941] 
     [bookmark: 54515]Virtual local area network (VLAN) 
    
 
     
     [bookmark: pgfId-2875942]VLANs map hosts not by geographic location, but by some other criterion, such as by department or primary use. A monitored host’s 
     host profile shows any VLAN information associated with the host. Innermost VLAN tag information is also included in various 
     events. The system can also perform multiple types of traffic handling including 
     access control, based on a connection’s VLAN tag. In Layer 2 and Layer 3 deployments, you can configure 
     virtual switches and 
     virtual routers on managed 
     devices to appropriately handle VLAN-tagged traffic. 
    
 
     
     [bookmark: pgfId-2600312] 
     [bookmark: 93422]virtual router 
    
 
     
     [bookmark: pgfId-2640547]A group of 
     routed interfaces that route Layer 3 traffic. In a Layer 3 deployment, you can configure virtual routers to route packets by making packet forwarding decisions according to the destination IP address. You can define static routes, configure Routing Information Protocol (RIP) and Open Shortest Path First (OSPF) dynamic routing protocols, as well as implement Network Address Translation ( 
     NAT). 
    
 
     
     [bookmark: pgfId-2600314] 
     [bookmark: 97238]virtual switch 
    
 
     
     [bookmark: pgfId-2649253]A group of 
     switched interfaces that process inbound and outbound traffic through your network. In a Layer 2 deployment, you can configure virtual switches on managed 
     devices to operate as standalone broadcast domains, dividing your network into logical segments. A virtual 
     switch uses the media access and control (MAC) address from a host to determine where to send packets. 
    
 
     
     [bookmark: pgfId-2875973]VLAN 
    
 
     
     [bookmark: pgfId-2875979]See 
     Virtual local area network (VLAN). 
    
 
     
     [bookmark: pgfId-2639366] 
     [bookmark: 99548]VLAN tag object 
    
 
     
     [bookmark: pgfId-2761265]A reusable 
     object that represents an individual 
     Virtual local area network (VLAN) tag. 
    
 
     
     [bookmark: pgfId-2761286] 
     [bookmark: 43694]VPN 
    
 
     
     [bookmark: pgfId-2761307]A feature that allows you to build secure 
     VPN tunnels between the 
     virtual routers of FireSIGHT System managed 
     devices. 
    
 
     
     [bookmark: pgfId-2761266]VPN license 
    
 
     
     [bookmark: pgfId-2761267]A license that allows you to build secure 
     VPN tunnels between the 
     virtual routers of FireSIGHT System 
     managed devices. 
    
 
     
     [bookmark: pgfId-2673682]VRT 
    
 
     
     [bookmark: pgfId-2673690]See 
     Cisco VRT. 
    
 
     
     [bookmark: pgfId-2808681] 
     [bookmark: 30209]VRT Analysis Report 
    
 
     
     [bookmark: pgfId-2808714]A record of the 
     Cisco VRT’s analysis of a 
     captured file submitted for 
     dynamic analysis, detailing the information presented in the 
     dynamic analysis summary report, as well as additional information discovered during dynamic analysis. 
    
 
     
     [bookmark: pgfId-2639372] 
     [bookmark: 99505]vulnerability 
    
 
     
     [bookmark: pgfId-2600330]A description of a specific compromise to which a 
     host is susceptible. The 
     Defense Center provides information on the vulnerabilities to which each of your hosts is vulnerable in the hosts’ 
     host profiles. In addition, you can use the vulnerabilities 
     network map to obtain an overall view of the vulnerabilities that the system has detected on your entire monitored network. If you deem a 
     host or hosts no longer vulnerable to a specific compromise, you can deactivate, or mark as invalid, a specific vulnerability. 
    
 
     
     [bookmark: pgfId-2600340] 
     [bookmark: 94075]vulnerability database 
    
 
     
     [bookmark: pgfId-2600341]Also called the VDB, a database of known vulnerabilities to which 
     hosts may be susceptible. The system correlates the operating system, 
     application protocols, and 
     clients detected on each host with the VDB to help you determine whether a particular host increases your risk of network compromise. VDB updates may contain new and updated vulnerabilities, as well as new and updated 
     application detectors. 
    
 
     
     [bookmark: pgfId-2600345] 
     [bookmark: 87211]vulnerability detail 
    
 
     
     [bookmark: pgfId-2600352]The final page in 
     vulnerability 
     workflows. Vulnerability details provide information about a specific 
     vulnerability, including technical details and known solutions. 
    
 
     
     [bookmark: pgfId-2600353] 
     [bookmark: 11058]vulnerability ID 
    
 
     
     [bookmark: pgfId-2600354]An identification number associated with a particular 
     vulnerability. The Cisco 
     vulnerability database and 
     third-party vulnerability databases, such as Bugtraq and CVE, have different vulnerability ID numbering schemes. 
    
 
     
     [bookmark: pgfId-2600355]vulnerability mapping 
    
 
     
     [bookmark: pgfId-2600356]The association of 
     vulnerability information with 
     discovery data, so that you can perform 
     impact 
     correlation. 
    
 
     
     [bookmark: pgfId-2600358] 
     [bookmark: 47201]web application 
    
 
     
     [bookmark: pgfId-2772914]A type of 
     application that represents the content of, or requested URL for, HTTP traffic. 
    
 
     
     [bookmark: pgfId-2772916] 
     [bookmark: 57238]whitelist 
    
 
     
     [bookmark: pgfId-2772923]A 
     compliance white list, a 
     Security Intelligence whitelist, the 
     HA link interface, or a list of IP addresses that you can configure within a 
     remediation to exempt IP addresses from some kind of action. 
    
 
     
     [bookmark: pgfId-2600371] 
     [bookmark: 49009]white list event 
    
 
     
     [bookmark: pgfId-2600375]An 
     event generated when the system detects that a valid target host has become non-compliant with a 
     compliance white list. White list events are a special kind of 
     correlation event. 
    
 
     
     [bookmark: pgfId-2605235] 
     [bookmark: 21146]white list violation 
    
 
     
     [bookmark: pgfId-2605251]Information that you can view in the 
     event viewer that details how a host is non-compliant with a 
     compliance white list. 
    
 
     
     [bookmark: pgfId-2605255]widget 
    
 
     
     [bookmark: pgfId-2600394]See 
     dashboard widget. 
    
 
     
     [bookmark: pgfId-2680109] 
     [bookmark: 63724]workflow 
    
 
     
     [bookmark: pgfId-2680113]A series of pages you can use to view and evaluate 
     events by moving from a broad view of event data to a more focused view that contains only the events of interest to you. Workflows can include three types of pages, each of which performs a unique function: 
     drill-down pages, 
     table views, and a final page. Depending on the workflow type, the final page may be a 
     table view, 
     packet view, 
     host view, 
     vulnerability detail, or 
     user details. 
    
 
     
     [bookmark: pgfId-2799847]X-Series 
    
 
     
     [bookmark: pgfId-2799854]The short name for 
     Cisco NGIPS for Blue Coat X-Series. 
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